Welcome

Welcome to DaVinci Resolve for Mac, Linux and Windows!

DaVinci is the world’s most trusted name in color and has been used to grade more Hollywood films, TV shows, and commercials than anything else. With DaVinci Resolve, you get a complete set of editing, advanced color correction, professional Fairlight audio post production tools and Fusion visual effects combined in one application so you can edit, compose, grade, mix and master deliverables from start to finish, all in a single tool!

DaVinci Resolve has the features professional editors, colorists, audio engineers and VFX artists need, and is built on completely modern technology with advanced audio, color and image processing that goes far beyond what any other system can do. With this release, we hope to inspire creativity by letting you work in a comfortable, familiar way, while also giving you an entirely new creative toolset that will help you cut and finish projects at higher quality than ever before!

We hope you enjoy reading this manual. With its customizable interface and keyboard shortcuts, DaVinci Resolve is easy to learn, especially if you’re switching from another editor, and has all of the tools you need to create breathtaking, high end work!

The DaVinci Resolve Engineering Team

Grant Petty
CEO Blackmagic Design
Getting Started

When you install DaVinci Resolve and then open it for the first time, there are a few things you’re going to want to know before you begin learning how to work.

Automatic DaVinci Resolve Updates

To make it easier to ensure you’re using the latest version of DaVinci Resolve, you can now choose DaVinci Resolve > Check For Updates to notify you of new versions and download them when available.

Why Is This Manual So Big?

Over the years, DaVinci Resolve has evolved to encompass professional editing, compositing, and audio mixing tools and workflows in addition to the grading tools that were the original core of DaVinci Resolve. Each one of these domains of functionality is incredibly deep. Consequently, the documentation has grown with each new page, tool, and parameter that’s been added, to make life easier and to solve the countless problems that can emerge during the postproduction process.

While it is regretted that this user manual contains such a staggeringly overwhelming amount of information, our emphasis has always been to ensure that (hopefully) every control and workflow you encounter in DaVinci Resolve is explained somewhere within the contents of these pages. Consequently, we hope that you find the hyperlinked table of contents (TOC) and search functionality of your preferred PDF browser helpful in finding the information you need, along with context and tips to help you get the most out of the tools provided.

Navigation Guide

Chapter 3

Managing Projects and Databases

This chapter covers how to use the Project Manager to organize the projects you’re working on in DaVinci Resolve, as well as how to deal with managing the databases that serve as the organizational foundation of the Project Manager. You’ll also see how to export and import projects, and how to archive a project and its media for long-term storage.

Contents

- Using the Project Manager 68
- Project Management 68
- Importing DaVinci Resolve Projects (.DRP Files) 68
- Project Manager View Options 70
- Saving for Projects 71
- Organizing Projects in Folders 72
- Opening the Databases Sidebar 72
- Moving Projects From One Database to Another on the Same Workstation 73
- Managing Databases in the Databases Sidebar 73
- Legacy User Organization in the Databases Sidebar 78
- Saving Projects 79
- Live Save 79
- Project Backups 80
- Project Notes 82
- Dynamic Project Switching 82
- Archiving and Restoring Projects 83
Contents

PART 1

DaVinci Resolve Interface

1 Introduction to DaVinci Resolve 12
2 Using the DaVinci Resolve User Interface 49

PART 2

Setup and Workflows

3 Managing Projects and Databases 67
4 System and User Preferences 85
5 Project Settings 111
6 Camera Raw Settings 134
7 Improving Performance, Proxies, and the Render Cache 158
8 Data Levels, Color Management, and ACES 180
9 HDR Setup and Grading 209
10 Image Sizing and Resolution Independence 232
11 Data Burn 246
12 Frame.io Integration 252
13 Resolve Live 258
14 Stereoscopic Workflows 263
15 Using Variables and Keywords 284

PART 3

Ingest and Organize Media

16 Using the Media Page 290
17 Adding and Organizing Media with the Media Pool 309
18 Using Clip Metadata 340
19 Using the Inspector in the Media Page 352
20 Syncing Audio and Video 360
21 Modifying Clips and Clip Attributes 366
22 Using Scene Detection 378
23 Ingesting From Tape 386
24 Capturing From the Cintel Film Scanner 393
## PART 4

### The Cut Page

<table>
<thead>
<tr>
<th>Page</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>Using the Cut Page</td>
<td>412</td>
</tr>
<tr>
<td>26</td>
<td>Importing and Organizing Media in the Cut Page</td>
<td>425</td>
</tr>
<tr>
<td>27</td>
<td>Fast Editing in the Cut Page</td>
<td>440</td>
</tr>
<tr>
<td>28</td>
<td>Trimming in the Cut Page</td>
<td>466</td>
</tr>
<tr>
<td>29</td>
<td>Using the Inspector in the Cut Page</td>
<td>480</td>
</tr>
<tr>
<td>30</td>
<td>Video and Audio Effects in the Cut Page</td>
<td>492</td>
</tr>
<tr>
<td>31</td>
<td>Quick Export</td>
<td>504</td>
</tr>
<tr>
<td>32</td>
<td>Using the DaVinci Editor Keyboard with the Cut Page</td>
<td>506</td>
</tr>
<tr>
<td>33</td>
<td>Using the DaVinci Resolve Speed Editor</td>
<td>524</td>
</tr>
</tbody>
</table>

## PART 5

### Edit

<table>
<thead>
<tr>
<th>Page</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>34</td>
<td>Using the Edit Page</td>
<td>541</td>
</tr>
<tr>
<td>35</td>
<td>Creating and Working with Timelines</td>
<td>577</td>
</tr>
<tr>
<td>36</td>
<td>Preparing Clips for Editing and Viewer Playback</td>
<td>591</td>
</tr>
<tr>
<td>37</td>
<td>Editing Basics</td>
<td>609</td>
</tr>
<tr>
<td>38</td>
<td>Using the Inspector in the Edit Page</td>
<td>637</td>
</tr>
<tr>
<td>39</td>
<td>Modifying Clips in the Timeline</td>
<td>649</td>
</tr>
<tr>
<td>40</td>
<td>Three- and Four-Point Editing</td>
<td>668</td>
</tr>
<tr>
<td>41</td>
<td>Marking and Finding Clips in the Timeline</td>
<td>694</td>
</tr>
<tr>
<td>42</td>
<td>Multicam Editing</td>
<td>718</td>
</tr>
<tr>
<td>43</td>
<td>Take Selectors, Compound Clips, and Nested Timelines</td>
<td>728</td>
</tr>
<tr>
<td>44</td>
<td>Trimming</td>
<td>738</td>
</tr>
<tr>
<td>45</td>
<td>Working with Audio in the Edit Page</td>
<td>770</td>
</tr>
<tr>
<td>46</td>
<td>Media Management</td>
<td>798</td>
</tr>
<tr>
<td>47</td>
<td>Using the DaVinci Editor Keyboard with the Edit Page</td>
<td>805</td>
</tr>
</tbody>
</table>

## PART 6

### Editing Effects and Transitions

<table>
<thead>
<tr>
<th>Page</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>48</td>
<td>Editing, Adding, and Copying Effects and Filters</td>
<td>821</td>
</tr>
<tr>
<td>49</td>
<td>Using Transitions</td>
<td>834</td>
</tr>
<tr>
<td>50</td>
<td>Titles, Generators, and Stills</td>
<td>851</td>
</tr>
<tr>
<td>51</td>
<td>Compositing and Transforms in the Timeline</td>
<td>864</td>
</tr>
<tr>
<td>52</td>
<td>Speed Effects</td>
<td>879</td>
</tr>
<tr>
<td>53</td>
<td>Subtitles and Closed Captioning</td>
<td>891</td>
</tr>
<tr>
<td>54</td>
<td>Keyframing Effects in the Edit Page</td>
<td>902</td>
</tr>
<tr>
<td>55</td>
<td>VFX Connect</td>
<td>914</td>
</tr>
</tbody>
</table>
PART 7

Import and Conform Projects

56 Preparing Timelines for Import and Comparison 922
57 Conforming and Relinking Clips 935
58 Creating Digital Dailies for Round Trip Workflows 959
59 Conforming XML Files 965
60 Conforming AAF Files 970
61 Conforming EDL Files 984

PART 8

Fusion Fundamentals

62 Introduction to Compositing in Fusion 991
63 Exploring the Fusion Interface 996
64 Getting Clips into Fusion 1042
65 Rendering Using Saver Nodes 1063
66 Working in the Node Editor 1086
67 Node Groups, Macros, and Fusion Templates 1130
68 Using Viewers 1150
69 Editing Parameters in the Inspector 1188
70 Animating in Fusion’s Keyframes Editor 1211
71 Animating in Fusion’s Spline Editor 1228
72 Animating with Motion Paths 1257
73 Using Modifiers, Expressions, and Custom Controls 1274
74 Bins 1286
75 Fusion Connect 1305
76 Preferences 1318
77 Controlling Image Processing and Resolution 1363
78 Managing Color for Visual Effects 1372
79 Understanding Image Channels 1384
80 Compositing Layers in Fusion 1418
81 Rotoscoping with Masks 1440
82 Paint 1462
83 Using the Tracker Node 1486
84 Planar Tracking 1518
85 Using Open FX, Resolve FX, and Fuse Plug-Ins 1524
86 3D Compositing Basics 1527
87 3D Camera Tracking 1579
88 Particle Systems 1596
89 Optical Flow and Stereoscopic Nodes 1604
## Fusion Page Effects

<table>
<thead>
<tr>
<th>Page</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>90</td>
<td>3D Nodes</td>
<td>1618</td>
</tr>
<tr>
<td>91</td>
<td>3D Light Nodes</td>
<td>1728</td>
</tr>
<tr>
<td>92</td>
<td>3D Material Nodes</td>
<td>1741</td>
</tr>
<tr>
<td>93</td>
<td>3D Texture Nodes</td>
<td>1768</td>
</tr>
<tr>
<td>94</td>
<td>Blur Nodes</td>
<td>1793</td>
</tr>
<tr>
<td>95</td>
<td>Color Nodes</td>
<td>1817</td>
</tr>
<tr>
<td>96</td>
<td>Composite Nodes</td>
<td>1872</td>
</tr>
<tr>
<td>97</td>
<td>Deep Pixel Nodes</td>
<td>1886</td>
</tr>
<tr>
<td>98</td>
<td>Effect Nodes</td>
<td>1902</td>
</tr>
<tr>
<td>99</td>
<td>Film Nodes</td>
<td>1933</td>
</tr>
<tr>
<td>100</td>
<td>Filter Nodes</td>
<td>1950</td>
</tr>
<tr>
<td>101</td>
<td>Flow Nodes</td>
<td>1966</td>
</tr>
<tr>
<td>102</td>
<td>Flow Organizational Nodes</td>
<td>1969</td>
</tr>
<tr>
<td>103</td>
<td>Fuses</td>
<td>1974</td>
</tr>
<tr>
<td>104</td>
<td>Generator Nodes</td>
<td>1976</td>
</tr>
<tr>
<td>105</td>
<td>I/O Nodes</td>
<td>2013</td>
</tr>
<tr>
<td>106</td>
<td>LUT Nodes</td>
<td>2036</td>
</tr>
<tr>
<td>107</td>
<td>Mask Nodes</td>
<td>2045</td>
</tr>
<tr>
<td>108</td>
<td>Matte Nodes</td>
<td>2082</td>
</tr>
<tr>
<td>109</td>
<td>Metadata Nodes</td>
<td>2135</td>
</tr>
<tr>
<td>110</td>
<td>Miscellaneous Nodes</td>
<td>2142</td>
</tr>
<tr>
<td>111</td>
<td>Optical Flow</td>
<td>2177</td>
</tr>
<tr>
<td>112</td>
<td>Paint Node</td>
<td>2190</td>
</tr>
<tr>
<td>113</td>
<td>Particle Nodes</td>
<td>2199</td>
</tr>
<tr>
<td>114</td>
<td>Position Nodes</td>
<td>2256</td>
</tr>
<tr>
<td>115</td>
<td>Resolve Connect</td>
<td>2274</td>
</tr>
<tr>
<td>116</td>
<td>Shape Nodes</td>
<td>2280</td>
</tr>
<tr>
<td>117</td>
<td>Stereo Nodes</td>
<td>2311</td>
</tr>
<tr>
<td>118</td>
<td>Tracker Nodes</td>
<td>2341</td>
</tr>
<tr>
<td>119</td>
<td>Transform Nodes</td>
<td>2386</td>
</tr>
<tr>
<td>120</td>
<td>VR Nodes</td>
<td>2411</td>
</tr>
<tr>
<td>121</td>
<td>Warp Nodes</td>
<td>2421</td>
</tr>
<tr>
<td>122</td>
<td>Modifiers</td>
<td>2449</td>
</tr>
</tbody>
</table>
# PART 10  
## Color

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>123</td>
<td>Introduction to Color Grading</td>
<td>2486</td>
</tr>
<tr>
<td>124</td>
<td>Using the Color Page</td>
<td>2497</td>
</tr>
<tr>
<td>125</td>
<td>Viewers, Monitoring, and Video Scopes</td>
<td>2513</td>
</tr>
<tr>
<td>126</td>
<td>Color Page Timeline and Lightbox</td>
<td>2547</td>
</tr>
<tr>
<td>127</td>
<td>Automated Grading Commands and Imported Grades</td>
<td>2562</td>
</tr>
<tr>
<td>128</td>
<td>Camera Raw Palette</td>
<td>2576</td>
</tr>
<tr>
<td>129</td>
<td>Primaries Palette</td>
<td>2582</td>
</tr>
<tr>
<td>130</td>
<td>HDR Palette</td>
<td>2599</td>
</tr>
<tr>
<td>131</td>
<td>Primary Grading Controls</td>
<td>2622</td>
</tr>
<tr>
<td>132</td>
<td>Curves</td>
<td>2626</td>
</tr>
<tr>
<td>133</td>
<td>Color Warper</td>
<td>2645</td>
</tr>
<tr>
<td>134</td>
<td>Secondary Qualifiers</td>
<td>2662</td>
</tr>
<tr>
<td>135</td>
<td>Secondary Windows and Tracking</td>
<td>2686</td>
</tr>
<tr>
<td>136</td>
<td>Magic Mask</td>
<td>2700</td>
</tr>
<tr>
<td>137</td>
<td>Motion Tracking Windows</td>
<td>2718</td>
</tr>
<tr>
<td>138</td>
<td>Using the Gallery</td>
<td>2741</td>
</tr>
<tr>
<td>139</td>
<td>Grade Management</td>
<td>2757</td>
</tr>
<tr>
<td>140</td>
<td>Node Editing Basics</td>
<td>2791</td>
</tr>
<tr>
<td>141</td>
<td>Image Processing Order of Operations</td>
<td>2809</td>
</tr>
<tr>
<td>142</td>
<td>Serial, Parallel, and Layer Nodes</td>
<td>2812</td>
</tr>
<tr>
<td>143</td>
<td>Combining Keys and Using Mattes</td>
<td>2819</td>
</tr>
<tr>
<td>144</td>
<td>Channel Splitting and Image Compositing</td>
<td>2841</td>
</tr>
<tr>
<td>145</td>
<td>Keyframing in the Color Page</td>
<td>2855</td>
</tr>
<tr>
<td>146</td>
<td>Copying and Importing Grades Using ColorTrace</td>
<td>2869</td>
</tr>
<tr>
<td>147</td>
<td>Using LUTs</td>
<td>2878</td>
</tr>
<tr>
<td>148</td>
<td>DaVinci Resolve Control Panels</td>
<td>2887</td>
</tr>
</tbody>
</table>

# PART 11  
## Color Page Effects

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>149</td>
<td>Using Open FX and Resolve FX</td>
<td>2961</td>
</tr>
<tr>
<td>150</td>
<td>Sizing and Image Stabilization</td>
<td>2972</td>
</tr>
<tr>
<td>151</td>
<td>The Motion Effects and Blur Palettes</td>
<td>2988</td>
</tr>
<tr>
<td>152</td>
<td>Dust Removal</td>
<td>2998</td>
</tr>
</tbody>
</table>
PART 12

Resolve FX Overview

153  Resolve FX 3002
154  Resolve FX Blur 3004
155  Resolve FX Color 3009
156  Resolve FX Generate 3022
157  Resolve FX Key 3025
158  Resolve FX Light 3036
159  Resolve FX Refine 3045
160  Resolve FX Revival 3054
161  Resolve FX Sharpen 3072
162  Resolve FX Stylize 3076
163  Resolve FX Temporal 3086
164  Resolve FX Texture 3089
165  Resolve FX Transform 3097
166  Resolve FX Warp 3120

PART 13

Fairlight

167  Using the Fairlight Page 3128
168  Setting Up Tracks, Buses, and Patching 3166
169  Transport Controls, Timeline Navigation, and Markers 3183
170  Recording 3191
171  ADR (Automated Dialog Replacement) 3198
172  Editing Basics in the Fairlight Page 3207
173  Audio Clip Specific Inspector Adjustments 3247
174  Mixing in the Fairlight Page 3259
175  Automation Recording 3285
176  Audio Effects 3296
177  Fairlight FX 3305
178  Audio Meters and Audio Monitoring 3332
179  Signal Flow Diagrams 3342
180  Immersive Audio Workflows 3344
181  Using the Fairlight Desktop Console 3357
182  Using the Fairlight Audio Editor 3407
183  Modular Fairlight Consoles 3454
# PART 14

**Deliver**

<table>
<thead>
<tr>
<th>Page</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>184</td>
<td>Delivery Effects Processing</td>
<td>3487</td>
</tr>
<tr>
<td>185</td>
<td>Using the Deliver Page</td>
<td>3492</td>
</tr>
<tr>
<td>186</td>
<td>Rendering Media</td>
<td>3499</td>
</tr>
<tr>
<td>187</td>
<td>Delivering DCP and IMF</td>
<td>3528</td>
</tr>
<tr>
<td>188</td>
<td>Delivering to Tape</td>
<td>3543</td>
</tr>
<tr>
<td>189</td>
<td>Exporting Timelines and Metadata</td>
<td>3550</td>
</tr>
</tbody>
</table>

# PART 15

**Advanced Workflows**

<table>
<thead>
<tr>
<th>Page</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>190</td>
<td>Workflow Integrations</td>
<td>3561</td>
</tr>
<tr>
<td>191</td>
<td>Creating DCTL LUTs</td>
<td>3565</td>
</tr>
<tr>
<td>192</td>
<td>TCP Protocol for DaVinci Resolve Transport Control</td>
<td>3570</td>
</tr>
</tbody>
</table>

# PART 16

**Project Databases, Collaborative, and Remote Workflows**

<table>
<thead>
<tr>
<th>Page</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>193</td>
<td>Managing Databases and Project Servers</td>
<td>3575</td>
</tr>
<tr>
<td>194</td>
<td>Collaborative Workflow</td>
<td>3582</td>
</tr>
<tr>
<td>195</td>
<td>Remote Grading</td>
<td>3596</td>
</tr>
</tbody>
</table>

# PART 17

**Other Information**

<table>
<thead>
<tr>
<th>Page</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>196</td>
<td>Regulatory Notices, Safety Information and Warranty</td>
<td>3600</td>
</tr>
</tbody>
</table>
PART 1

DaVinci Resolve Interface
Chapter 1

Introduction to DaVinci Resolve

DaVinci Resolve integrates editing, compositing and motion graphics, color correction, audio recording and mixing, and finishing within a single, easy to learn application. The editing, compositing, grading, and audio tools found in DaVinci Resolve should be immediately familiar to experienced artists who’ve used other applications, but they’re also approachable to folks who are new to post-production.

Additionally, dedicated tools available for on-set workflows integrate tasks such as media duplication, shot and metadata organization, and on-location look management into a complete toolset that lets you smoothly segue from the camera original media being acquired in the field to the organization and use of that media in a wide variety of post-production workflows with DaVinci Resolve at their heart. In particular, the tight integration in DaVinci Resolve means that you can freely move from one task to the next of your project’s workflow without skipping a beat, making it easy to back up and organize a shoot’s media before immediately diving into editing, while switching over to add a quick composite or to color-correct clips in the middle of your editing spree, and then getting right back to cutting, with a bit of mixing to make sure things sound right, all without needing to export projects or launch other applications.

And you can go further, using the collaborative features of DaVinci Resolve to enable multiple artists, for example an editor, a colorist, and assistants, to work together on the same timeline simultaneously, for the ultimate integrated workflow.

Of course, no post-production professional works in a vacuum, and DaVinci Resolve makes it easy to work with other facilities by importing projects and exporting project exchange formats and rendered or managed media among applications such as Apple’s Final Cut Pro X, Adobe’s Premiere Pro, Avid’s Media Composer and Pro Tools, Autodesk’s Flame Premium, and many other applications via robust support of XML, AAF, and EDL import and export workflows.

This chapter introduces the DaVinci Resolve user interface (UI), explaining where to find each group of features, and how the highly focused and tightly integrated Media, Edit, Fusion, Color, Fairlight, and Deliver pages work together to let you pursue nearly any post-production workflow you can imagine. After this brief tour, the rest of Part 1 of this manual provides much more in-depth information about project management, preferences, project settings, and other topics of general interest for getting started.
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Project Manager</td>
<td>14</td>
</tr>
<tr>
<td>Preferences and Project Settings</td>
<td>14</td>
</tr>
<tr>
<td>Individual Preferences and Settings Based on Login</td>
<td>14</td>
</tr>
<tr>
<td>Preferences</td>
<td>15</td>
</tr>
<tr>
<td>System Preferences</td>
<td>15</td>
</tr>
<tr>
<td>User Preferences</td>
<td>16</td>
</tr>
<tr>
<td>Project Settings</td>
<td>16</td>
</tr>
<tr>
<td>Switching Among Pages</td>
<td>17</td>
</tr>
<tr>
<td>Minimizing the Resolve Page Bar</td>
<td>17</td>
</tr>
<tr>
<td>Switching Pages Using Keyboard Shortcuts</td>
<td>18</td>
</tr>
<tr>
<td>Hide Pages You Don’t Use</td>
<td>18</td>
</tr>
<tr>
<td>Hide Page Navigation Altogether</td>
<td>18</td>
</tr>
<tr>
<td>The Media Page</td>
<td>18</td>
</tr>
<tr>
<td>The Media Storage Browser</td>
<td>19</td>
</tr>
<tr>
<td>Viewer</td>
<td>19</td>
</tr>
<tr>
<td>Media Pool</td>
<td>20</td>
</tr>
<tr>
<td>Metadata Editor</td>
<td>21</td>
</tr>
<tr>
<td>Audio Panel</td>
<td>21</td>
</tr>
<tr>
<td>The Cut Page</td>
<td>22</td>
</tr>
<tr>
<td>The Media Pool</td>
<td>22</td>
</tr>
<tr>
<td>The Viewer</td>
<td>23</td>
</tr>
<tr>
<td>Audio Meter</td>
<td>24</td>
</tr>
<tr>
<td>The Timeline</td>
<td>24</td>
</tr>
<tr>
<td>The Edit Page</td>
<td>25</td>
</tr>
<tr>
<td>The Media Pool</td>
<td>26</td>
</tr>
<tr>
<td>Effects Library Browsing</td>
<td>26</td>
</tr>
<tr>
<td>Edit Index</td>
<td>27</td>
</tr>
<tr>
<td>Source/Offline and Timeline Viewers</td>
<td>27</td>
</tr>
<tr>
<td>Inspector</td>
<td>28</td>
</tr>
<tr>
<td>Toolbar</td>
<td>29</td>
</tr>
<tr>
<td>Timeline</td>
<td>29</td>
</tr>
<tr>
<td>Floating Timecode Window</td>
<td>29</td>
</tr>
<tr>
<td>Motion Graphics and Visual Effects in DaVinci Resolve</td>
<td>30</td>
</tr>
<tr>
<td>VFX Connect</td>
<td>30</td>
</tr>
<tr>
<td>The Fusion Page</td>
<td>31</td>
</tr>
<tr>
<td>The Work Area</td>
<td>31</td>
</tr>
<tr>
<td>Viewers</td>
<td>32</td>
</tr>
<tr>
<td>Toolbar</td>
<td>32</td>
</tr>
<tr>
<td>Effects Library</td>
<td>32</td>
</tr>
<tr>
<td>Node Editor</td>
<td>33</td>
</tr>
<tr>
<td>Inspector</td>
<td>34</td>
</tr>
<tr>
<td>Thumbnail Timeline</td>
<td>34</td>
</tr>
<tr>
<td>Media Pool</td>
<td>35</td>
</tr>
<tr>
<td>Status Bar</td>
<td>35</td>
</tr>
<tr>
<td>The Console</td>
<td>35</td>
</tr>
<tr>
<td>The Color Page</td>
<td>36</td>
</tr>
<tr>
<td>Viewer</td>
<td>37</td>
</tr>
<tr>
<td>Gallery</td>
<td>37</td>
</tr>
<tr>
<td>Node Editor</td>
<td>38</td>
</tr>
<tr>
<td>Timeline</td>
<td>38</td>
</tr>
<tr>
<td>Left Palettes</td>
<td>39</td>
</tr>
<tr>
<td>Center Palettes</td>
<td>39</td>
</tr>
<tr>
<td>Keyframe Editor</td>
<td>39</td>
</tr>
<tr>
<td>The Fairlight Page</td>
<td>40</td>
</tr>
<tr>
<td>The Audio Timeline</td>
<td>41</td>
</tr>
<tr>
<td>Toolbar</td>
<td>42</td>
</tr>
<tr>
<td>Mixer</td>
<td>42</td>
</tr>
<tr>
<td>Dedicated Channel Strip Controls</td>
<td>43</td>
</tr>
<tr>
<td>The Monitoring Panel</td>
<td>45</td>
</tr>
<tr>
<td>Floating Timecode Window</td>
<td>45</td>
</tr>
<tr>
<td>The Deliver Page</td>
<td>45</td>
</tr>
<tr>
<td>The Render Settings List</td>
<td>46</td>
</tr>
<tr>
<td>The Deliver Page Timeline</td>
<td>47</td>
</tr>
<tr>
<td>The Viewer</td>
<td>47</td>
</tr>
<tr>
<td>The Render Queue</td>
<td>48</td>
</tr>
</tbody>
</table>

Chapter 1  Introduction to DaVinci Resolve  13
The Project Manager

For most users, Project Manager is the first window you’ll see when you open DaVinci Resolve. The Project Manager is a centralized interface for managing all projects belonging to the user who’s currently logged in, whose name appears at the upper right-hand corner in a project title bar. The Project Manager is also the place where you import and export projects to and from DaVinci Resolve, whether you’re moving projects around from user to user, or moving projects from one DaVinci Resolve workstation to another. Finally, the Project Manager also lets you organize the databases that are used to manage everything in DaVinci Resolve using the Database Sidebar.

To open any project, double-click it. To create a new project, double-click the Untitled Project icon, or click the New Project button.

The Project Manager shows all projects belonging to the current user.

For more information about the Project Manager, see Chapter 3, “Managing Projects and Databases.”

Preferences and Project Settings

Once you open a project, you have the option of adjusting the System and User Preferences that govern the installation of DaVinci Resolve on your workstation, and the Project Settings governing the currently open project. When you first install DaVinci Resolve, the most important of these settings are selected via the installer’s on boarding questions. However, if you’re opening DaVinci Resolve for the first time, you should probably check these settings to make sure they’re optimal for your system.

Individual Preferences and Settings Based on Login

As of DaVinci Resolve 16, there are individual preferences and settings for each login account on a given computer. This means that multiple artists can each have their own login, and DaVinci Resolve will maintain separate workspace layouts and preference states for each artist, depending on who’s logged in.
Preferences

The Preferences window, divided into System preferences and User preferences panels, lets you set up the overall environment of your DaVinci workstation, choosing what hardware to use with DaVinci Resolve and what user interface settings you prefer as you work.

A quick overview of the most important System and User preferences appears below, with guidance about the first settings you should adjust when you first set DaVinci Resolve up on your workstation. However, for a comprehensive overview and for more information, see Chapter 4, “System and User Preferences.”

System Preferences

The System preferences let you configure the hardware DaVinci Resolve works with. If you have a system that doesn’t change very often, then you may only rarely use the Preferences window. On the other hand, if you’re working with a mobile system with changing video interfaces, control panels, and scratch volumes, then you may use this window more frequently.

**NOTE:** Whenever you change certain core System Settings in the Preferences, you may have to quit and restart DaVinci Resolve for those changes to take effect.

Hardware Configuration

Lets you choose various options governing how to use the GPUs attached to your computer, and how to configure Viewers in different pages. This panel also provides an overview, for reference, of all hardware and computer characteristics that are relevant to DaVinci Resolve running smoothly, including a listing of installed GPUs.
Media Storage
This is a list within which you define the scratch disk used by your system. The first volume in this list is where Gallery stills and cache files are stored, so you want to make sure that you choose the fastest storage volume that’s connected.

Video and Audio I/O
The preferences in this panel let you choose which video and audio interfaces you want DaVinci Resolve to use on your workstation. If you have multiple Blackmagic Design I/O interfaces connected to your computer, you can choose one to use for monitoring video output, and one to use for Resolve Live, a feature that lets you grade camera output during a shoot as part of an on-set workflow.

Control Panels
Lets you choose and configure (if necessary) a control panel that’s connected for use during grading in DaVinci Resolve.

User Preferences
User preferences govern the setup of the user interface in DaVinci Resolve, letting you customize it to work the way you like.

UI Settings
A Language drop-down at top lets you specify which language the DaVinci Resolve user interface displays. DaVinci Resolve currently supports English, Chinese, Japanese, and Spanish. Additional checkboxes let you choose options for which project to open during startup, and how to configure the Viewers that appear in every page of DaVinci Resolve.

Project Save and Load
This panel contains the all-important auto-save controls, including the Live Save option that enables Resolve to incrementally save your changes as you work.

Editing
Numerous controls in this panel let you customize the editing experience in the Edit page, including default settings to use when making new timelines, and general settings that govern standard effects durations and trim behaviors.

Color
These controls let you customize the grading experience in the Color page, with options controlling video scope display, the look of UI overlays, and other color-specific functions.

Keyboard Mapping
This panel has all the controls you need for searching for and customizing the keyboard shortcuts used for different commands throughout DaVinci Resolve.

Project Settings
Once you’ve created a project, all project-specific settings are found in the Project Settings window. To open the Project Settings window, just click the gear button at the bottom right on any page.
The Project Settings open in the middle of the screen, divided into a series of panels which can be selected from a sidebar to the left. Each panel contains a collection of related settings that affects some category of DaVinci Resolve functionality. To open a panel of settings, simply click its name in the sidebar at the left.

The Project Settings show all project-specific settings and attributes.

The Master Settings define the principal attributes of a project, such as the timeline resolution, timeline frame rate, color science, and bit depth. Image Scaling settings define how clips that don’t match the timeline resolution are scaled to fit. There are other panels for Color Management, Camera Raw, Capture and Playback, etc.

For more information about Project Settings, see Chapter 4, “System and User Preferences.”

## Switching Among Pages

Buttons for switching pages appear at the bottom of the UI.

DaVinci Resolve is divided into seven main pages of functionality, each of which facilitates a different specialization of a typical post production workflow, and each of which can be accessed using buttons at the very bottom of the DaVinci Resolve interface. These buttons are organized in order of workflow, and they’re always available, letting you quickly switch between importing media, fast editing, detailed editing, compositing, grading, audio mixing, and outputting your project in a structured manner.

## Minimizing the Resolve Page Bar

If you right-click anywhere within the Resolve Page bar at the bottom of the DaVinci Resolve UI, two options appear in a contextual menu: “Show Icons and Labels” and “Show Icons Only.” If you show icons only, the Resolve Page bar at the bottom takes less room.
Switching Pages Using Keyboard Shortcuts

You can also switch pages using the following keyboard shortcuts, which can be referenced from the Workspace > Switch to Page submenu.

Hide Pages You Don’t Use

You can leave the page navigation bar showing and just hide the buttons of specific pages. For example:

– If you like the quick navigation of this bar but there are pages you simply don’t want to use
– If you’re setting up a DaVinci Resolve workstation for an artist making specific contributions to a project, and you want to hide easy access to pages of functionality they won’t (or shouldn’t) be using; this can be especially useful in collaborative workflow projects

You can disable/re-enable each page’s buttons using the Workspace > Show Page submenu. Effects and adjustments that have been applied on hidden pages continue to affect the current project, they’re only hidden, and you can still navigate to them using the Workspace > Switch to Page submenu commands or keyboard shortcuts.

Hide Page Navigation Altogether

If you’re an artist that only uses a single page of the DaVinci Resolve experience, or if you want more screen real estate to work with given your existing computer display’s parsimonious resolution, you can choose Workspace > Show Page Navigation to hide the page navigation bar at the bottom of the DaVinci Resolve user interface. While this bar is closed, you can still navigate to other pages using the Workspace > Switch to Page submenu commands or keyboard shortcuts.

To toggle the Show Page Navigation function:

– Check Workspace > Show Page Navigation.

With this interface element hidden, you can use keyboard shortcuts to access the individual pages (Shift - 2 through 8), Project manager (Shift - 1), and Project settings (Shift - 9). You can also access these functions from DaVinci Resolve’s main menu bar.

The Media Page

The Media page is the primary interface for clip import, media management, and clip organization in DaVinci Resolve. It’s central to the way DaVinci Resolve works that the source media used by a project is organized separately from the project data that you import and manage in the Edit page. In this way, you can manage and update the clips used by timelines in the current project with ease, switching between offline and online media, reorganizing clips, and troubleshooting any problems that occur.

The Media page also contains much of the core functionality that will be used for on-set workflows, and in the ingest, organizational, and sound-syncing steps of digital dailies workflows. This chapter covers most of the functionality found in the Media page, including functions in detail that are referenced throughout this manual.
The Media page is divided into six different areas, designed to make it easy to find, select, and work with media in your project. Much of the functionality and most of the commands are found within the contextual menus that appear when you right-click clips in the Library, File Browser, or Media Pool.

For more information on using the Media page, see Chapter 16, “Using the Media Page.”

**The Media Storage Browser**

The Media Storage browser shows a list of all volumes that are currently available to your Resolve workstation. It’s used to locate media that you want to import manually into your project.

**Viewer**

Clips that you select in any area of the Media page show their contents in the Viewer. A jog bar appears at the bottom, letting you drag the playhead directly with the pointer, while a jog control between the mode drop-down and transport controls lets you move through a long clip more slowly.
The full width of the jog bar represents the full duration of the clip in the Viewer. The current position of the playhead is shown in the timecode field at the upper right-hand corner of the Viewer.

Simple transport controls appear underneath the jog bar, letting you Jump to First Frame, Play/Stop, and Jump to Last Frame.

You can also put the Viewer into Cinema Viewer mode by choosing Workspace > Viewer Mode > Cinema Viewer (Command-F), so that it fills the entire screen. This command toggles Cinema Viewer mode on and off.

If you have two monitors connected to your computer, you can make the Viewer fill one entire screen and keep the Resolve UI in the other monitor by choosing Workspace > Full Screen Viewer On, and selecting the display you wish to use for the Viewer.

**Media Pool**

The Media Pool contains all of the video, audio, and still image media that you import into the current project. It also contains any media that’s automatically imported along with timelines that have been imported into DaVinci Resolve. Ordinarily, all media imported into a project goes into the Master bin, however the Media Pool can be organized into as many user-definable bins as you like, depending on your needs. Media can be freely moved from one bin to another from within the Media Pool. The Media Pool also appears on the Edit, Fusion, Color, and Fairlight pages, making it possible to browse and open clips and timelines everywhere they’re relevant.
Metadata Editor

When you select a clip in any area of the Media page, its metadata is displayed within the Metadata Editor. If you select multiple clips, only the last clip’s information appears. The Metadata Editor’s header contains uneditable information about the selected clip, including the file name, directory, duration, frame rate, resolution, and codec. A series of editable fields within the Metadata Editor lets you review and edit the different metadata items that are available.

A drop-down menu at the upper-right of the Metadata Editor lets you choose from many different sets of metadata fields and checkboxes, each grouped for a specific task or workflow.

Audio Panel

The Audio panel can be put into one of two modes via a pair of buttons above the audio meters. In the default Meters mode, Audio Meters are displayed that show the levels of audio in clips you’re playing. In Waveform mode, you can load audio clips side by side with video clips opened in the Viewer in order to sync them together manually. The Audio panel can also be hidden.
The Cut Page

The Cut page is a focused environment for fast editing. It’s useful in situations where you need to quickly cut a news segment, build an episode of web content, edit a straightforward program, experiment with multiple arrangements of a scene, or put together a first assembly edit.

The Cut page is also a good introductory editing interface for people who are new to editing, as it presents a streamlined set of tools that are fast to learn and simple to use. Whatever your background, you’ll find the Cut page to be a valuable addition to your editing experience in DaVinci Resolve.

The default workspace of the Cut page consists of the Media Pool, a single Viewer, and the Timeline area. These three regions let you quickly import and organize clips, edit clips, and even export the result, all from within the Cut page.

The Cut page default workspace, with the Media Pool in filmstrip view

For more information on the Cut page, see Chapter 25, “Using the Cut Page.”

The Media Pool

The Media Pool appears in the Cut page as well, and contains all video clips, audio clips, graphics, and other media that you import into your project. You can create Bins with which to organize all of this media, to make it easier to find what you need quickly. These bins are opened via the bin drop-down at the upper left-hand corner.

Each piece of media you import, whether it’s video, audio, or graphics, appears as an individual clip, and they can be selected, scrubbed for fast viewing, reorganized into bins, opened into the Viewer for playback, or edited into a timeline using the edit buttons or via drag and drop.

Owing to the Cut page’s mission to make editing faster, the Media Pool has different options for viewing (such as the filmstrip view) and customizing.
The Viewer

The Viewer lets you see clips from the Media Pool or clips in the Timeline play, and has numerous controls to control what you see and how things play.

The Viewer has three options. Which option is currently in use can be seen, and switched, by three buttons in the upper lefthand corner of the Viewer.

Different options are entered automatically by various actions:

- You can double-click any clip to open it into the Viewer as a Source Clip (the left button)
- You can view an entire bin full of clips in the Source Tape (the middle button)
- You can play your edited program in the Timeline (the right button)

Eight controls sit at the bottom of the Viewer. These let you play through and otherwise navigate clips and the Timeline in different ways.
Clicking the Tools button in the lower left of the Viewer reveals an effects toolbar that you can use to add and edit clip effects, right within the Viewer with no Inspector needed. The Tools button reveals a variety of controls over sizing, cropping, audio, speed effects, stabilization, dynamic zoom, and compositing, covered in more detail later in this chapter.

The Tools bar shown opened

**Audio Meter**

An audio meter to the right of the Viewer shows you a graphical representation of the audio levels playing in the current clip or in the Timeline as you play through the Viewer, via animated vertical bars that are tinted to indicate how loud the levels are.

**The Timeline**

The word “timeline” refers both to an edited sequence of clips which constitutes a program that is stored in the Media Pool, and to the area of the Cut page interface where you can open this sequence of clips to see its contents, and for playback and editing.

For the Cut page user, the timeline is divided into an Upper Timeline at the top, and a larger and more detailed Timeline Editor showing a zoomed in portion of the timeline around the playhead at the bottom. Working together, these two views of your edited sequence make it possible to navigate your entire project and cut in great detail.

The Timeline of the Cut page, comprising the Upper Timeline and the zoomed in Timeline

A pair of buttons at the upper left-hand corner of the Timeline lets you choose whether you use a locked or free playhead.

Two buttons let you choose to use a locked or free playhead

The Timeline is divided into multiple tracks, with each track capable of holding a sequence of clips in order to create a program. The main tracks, which are labeled numerically, combine a clip’s video and audio into a single item in the Timeline, for simplicity. Editing the In or Out point of a clip edits the video and audio together.
Track 1 shows combined Video+Audio tracks in the Cut page Timeline.

**TIP:** In the Edit page, Video+Audio clips are presented as separated Video and Audio items on different tracks. When you open the Fairlight page, audio is presented on tracks with lanes, where each audio channel can be seen. In this way, each page gives you different sets of controls over the contents of the timeline that are appropriate for each page.

## The Edit Page

The Edit page exposes a source-record style NLE that incorporates many specialized features for both creative editing and finishing. The Edit page is divided into three main regions: the browsers found at the left, the Viewers at the top, and the Timeline at the bottom, all of which work together to let you import, edit, and trim timelines with a flexible variety of tools and methods.

For more information on the Edit page, see Chapter 34, “Using the Edit Page.”
The Media Pool

As with everywhere else it appears in DaVinci Resolve, the Media Pool lets you organize and peruse all of the media and timelines in a project. DaVinci Resolve projects may contain one or more edited timelines (sometimes called a sequence in other applications).

The Media Pool in the Edit page is identical to that shown on the Media, Fusion, Color, and Fairlight pages, and shows you all of the source clips and timelines that are available for editing. A Bin list at the left shows a hierarchical list of folders that you can use to organize your media. By default, the Media Pool has a single bin, named “Master,” but you can add more bins as necessary to organize your clips, opening any of them to expose their contents with a single click. The Bin list can be hidden or shown via the button at the upper-left of the Media Pool. A browser to the right shows the contents of the currently selected bin.

![The Media Pool in Thumbnail mode](image)

Effects Library Browsing

The Effects Library contains a folder with the different Video Transitions, Title Effects, Generators, and Filters that are available for editing in the Timeline. The Effects Library has two panels, a Toolbox panel that contains the default Transitions, Titles, and Generators that Resolve comes with, and an OpenFX panel that contains any OpenFX transitions and generators you might have installed on your system.

![The Effects Library](image)
Edit Index

Clicking the Edit Index button opens the Edit Index. By default, this shows an EDL-style list view of all the edit events in the current timeline. Whichever timeline is selected in the Timeline list displays its events here; each clip and transition is shown as an individual event, each of which contains multiple columns of information. If you re-edit a timeline, your changes are automatically reflected in this list.

Source/Offline and Timeline Viewers

The Source Viewer lets you view individual clips from the Media Pool to prepare them for editing. Meanwhile, the Timeline Viewer shows the frame at the position of the playhead in the Timeline. You can select either viewer by clicking, and the name of the viewer that currently has focus appears in orange. The color shown in the Source Viewer usually reflects that of the original source media, while the Timeline Viewer shows whatever grading you’ve done in the Color page.
If you want to change the Edit page layout to hide the Source Viewer, you can choose Workspace > Single Viewer Mode to hide the Source Viewer and instead use just a single viewer to contextually display either a selected Source Clip or the current frame of the Timeline.

In Single Viewer mode, whatever you select in the Media Pool or Timeline determines which controls appear in the Viewer, which lets you do nearly everything you can do with two simultaneously open viewers.

You can also put either the Source or Timeline Viewers into Cinema Viewer mode by choosing Workspace > Viewer Mode > Cinema Viewer (Command-F), causing whichever viewer is currently selected to fill the entire screen. This command toggles Cinema Viewer mode on and off.

**Inspector**

The Inspector can be opened to let you customize compositing, transform, and cropping parameters for clips, as well as clip-specific retiming and scaling options. Furthermore, the Inspector lets you edit the parameters of transitions, titles, and generators used in the Timeline, in order to customize their effect. Ordinarily, the Inspector opens alongside the Source and Timeline Viewers, but on smaller displays, opening the Inspector switches the Edit page to a single-viewer mode, showing you the Timeline item that you’re inspecting alongside the Inspector with that clip’s parameters.
**Toolbar**

Eleven buttons starting from the left, running along the top of the Timeline, let you choose different tools for performing various editing functions.

![Buttons in the toolbar](image)

**Timeline**

The Timeline shows whichever timeline you’ve double-clicked in the Timelines browser. It’s the workspace where you either edit programs together from scratch, or import sequences from other applications to work on inside of Resolve. You can only have one Timeline open at a time.

The Timeline is divided into audio and video tracks, each of which has a series of header controls at the left that let you choose destination tracks for editing, name tracks, and turn tracks on and off, among other things. The appearance of the Timeline can be customized using the Timeline View Options drop-down in the toolbar.

![An edited timeline](image)

**Floating Timecode Window**

A timecode window is available from the Workspace menu on every page, including the Edit page. Choosing this option displays a floating timecode window that shows the timecode of the Viewer or Timeline that currently has focus. This window is resizable so you can make the timecode larger or smaller.

![A new floating timecode window is available](image)
Motion Graphics and Visual Effects in DaVinci Resolve

To begin with, DaVinci Resolve has a wealth of effects in both the Edit and Color pages for creating titles, transforming and animating clips, compositing and creating transparency effects, cutting mattes, applying filters, image stabilization, lens dewarping, and so on.

Then of course there’s the Fusion page, which adds considerably more powerful VFX and motion graphics capabilities via its node-based interface and deep toolset of effects nodes, keyframing and curve editing controls, and 2D and 3D compositing features.

To use DaVinci Resolve to the best effect, it’s prudent to begin to think of the Edit, Fusion, and Color pages as complementary sets of controls.

- For editors, the Fusion and Color pages are really just two giant inspectors; one filled with every compositing tool you could hope to use, and the other filled with every control for color and visual adjustment you could want, each of which are only one click away.

- For compositing artists, the Edit page can be considered a robust shot management interface as well as an opportunity to do VFX work that’s deeply integrated with the edit of the program you’re working on.

- For colorists, the Edit page is a refined environment for dealing with conform issues and taking care of myriad finishing tasks quickly and easily, that itself is only one click away. For more information on the effects that are available in DaVinci Resolve, see the chapters available within Part 4, “Edit Page Effects,” and Part 7, “Color Page Effects.”

VFX Connect

As robust as the built-in compositing capabilities of DaVinci Resolve now are, when you run into instances where the various capabilities found in the Edit, Fusion, and Color pages aren’t enough to achieve the effect you require, you can use the VFX Connect features of DaVinci Resolve to send one or more clips from the Edit page Timeline to Blackmagic Fusion, the powerful node-based compositing application from Blackmagic Design, in order to do more robust compositing and effects work there. Furthermore, the VFX Connect feature can also be used to round-trip media to and render results from third-party applications such as The Foundry’s Nuke, Autodesk Flame, or Blender.

This is a simple round-trip operation that lets you send clips from the DaVinci Resolve timeline to Fusion or another application, where you’ll add effects and do whatever work needs to be done before rendering a finished effect file that, if properly named, will automatically appear back in your timeline. When you use VFX Connect with Blackmagic Fusion, a project file is automatically generated and the render path is automatically named for automatic linking from the DaVinci Resolve timeline. If you use this feature with third-party applications, you’ll need to set up the naming of your rendered effect file manually. For more information, see Chapter 62, “Introduction to Compositing in Fusion.”
The Fusion Page

The Fusion page is intended, eventually, to be a feature-complete integration of Blackmagic Design Fusion, a powerful 2D and 3D compositing application with over thirty years of evolution serving the film and broadcast industry, creating effects that have been seen in countless films and television series.

Merged right into DaVinci Resolve with a newly updated user interface, the Fusion page makes it possible to jump immediately from editing right into compositing, with no need to export media, relink files, or launch another application to get your work done. Everything you need now lives right inside DaVinci Resolve.

For more information on using the Fusion page, see Chapter 62, “Introduction to Compositing in Fusion.”

The Work Area

You’ll probably not see this term used much, in favor of the specific panels within the work area that you’ll be using, but the area referred to as the Work Area is the region at the bottom half of the Fusion page UI, within which you can expose the three main panels used to construct compositions and edit animations in the Fusion page. These are the Node Editor, the Spline Editor, and the Keyframes Editor. By default, the Node Editor is the first thing you’ll see, and the main area you’ll be working within, but it can sit side-by-side with the Spline Editor and Keyframes Editor as necessary, and you can make more horizontal room on your display for these three panels by putting the Effects Library and Inspector into half-height mode, if necessary.
**Viewers**

The Viewer Area area encompasses the Time Ruler and transport controls. The Time Ruler is the principal “timeline” of the Fusion page, which focuses exclusively on the current composition you’re working on and may consist of one clip or several. This area can be set to display either one or two viewers at the top of the Fusion page, chosen via the Viewer button at the far right of the Viewer title bar. Each viewer can show a single node’s output from anywhere in the node tree. You assign which node is displayed in which viewer. This makes it easy to load separate nodes into each viewer for comparison. For example, you can load a Keyer node into the left Viewer and the final composite into the right Viewer, so you can see the image you’re adjusting and the final result at the same time.

![Dual viewers let you edit an upstream node in one while seeing its effect on the overall composition in the other](image)

Ordinarily, each viewer shows 2D nodes from your composition as a single image. However, when you’re viewing a 3D node, you have the option to set that viewer to one of several 3D views, including a perspective view that gives you a repositionable stage on which to arrange the elements of the world you’re creating, or a quad view that lets you see your composition from four angles, making it easier to arrange and edit objects and layers within the XYZ axes of the 3D space in which you’re working.

**Toolbar**

The toolbar, located underneath the Time Ruler, contains buttons that let you quickly add commonly used nodes to the Node Editor. Clicking any of these buttons adds that node after the currently selected node in the node tree, or adds an unconnected instance of that node if no nodes are selected. The toolbar is divided into six sections that group commonly used nodes together. As you hover the pointer over any button, a tooltip shows you that node’s name.

![The toolbar has buttons for adding commonly used nodes to the Node Editor](image)

**Effects Library**

The Effects Library on the Fusion page shows all of the nodes and effects that are available in the Fusion page, including effects that come with DaVinci Resolve and third-party OFX, if available. While the toolbar shows many of the most common nodes you’ll be using in any composite, the Effects Library contains every single tool available in the Fusion page, organized by category, with each node ready to be quickly added to the Node Editor. Suffice it to say there are many, many more nodes available in the Effects Library than on the toolbar, spanning a wide range of uses.
The Node Editor is the heart of the Fusion page, because it’s where you build the tree of nodes that makes up each composition. Each node you add to the node tree adds a specific operation that creates one effect, whether it’s blurring the image, adjusting color, painting strokes, drawing and adding a mask, extracting a key, creating text, or compositing two images into one.

You can think of each node as a layer in an effects stack, except that you have the freedom to route image data in any direction to branch and merge different segments of your composite in completely nonlinear ways. This makes it easy to build complex effects, but it also makes it easy to see what’s happening, since the node tree doubles as a flowchart that clearly shows you everything that’s happening, once you learn to read it.
The Inspector is a panel on the right side of the Fusion page that you use to display and manipulate the parameters of one or more selected nodes. When a node is selected in the Node Editor, its parameters and settings appear in the Inspector, ready for you to modify. The Fusion Inspector is divided into two panels. The Tools panel shows you the parameters of selected nodes. The Modifiers panel shows you different things for different nodes. For all nodes, it shows you the controls for Modifiers, or adjustable expressions, that you’ve added to specific parameters to automatically animate them in different ways.

Additionally, many nodes expose multiple tabs’ worth of controls in the Inspector, seen as icons at the top of the parameter section for each node. Click any tab to expose that set of controls.

Hidden by default, the Thumbnail timeline can be opened by clicking the Clips button in the UI Toolbar and appears underneath the Node Editor when it’s open. The Thumbnail timeline shows you every clip in the current Timeline, giving you a way to navigate from one clip to another when working on multiple compositions in your project and providing an interface for creating and switching among multiple versions of compositions and resetting the current composition, when necessary.
Media Pool

In the Fusion page, the Media Pool continues to serve its purpose as the repository of all media you’ve imported into your project. This makes it easy to add additional clips to your compositions simply by dragging the clip you want from the Media Pool into the Node Editor. The media you add appears as a new MediaIn node in your composition, ready to be integrated into your node tree however you need.

The Media Pool in Thumbnail mode showing video clips

Status Bar

The status bar at the bottom of the Fusion page, immediately above the Resolve Page bar, shows you a variety of up-to-date information about things you’re selecting and what’s happening in the Fusion page. For example, hovering the pointer over any node displays information about that node in the status bar (as well as in a floating tooltip), while the currently achieved frame rate appears whenever you initiate playback, and the percentage of the RAM cache that’s used appears at all times. Other information, updates, and warnings appears in this area as you work.

The status bar under the Node Editor showing you information about a node under the pointer

The Console

The console, available by choosing Workspace > Console, is a window in which you can see the error, log, script, and input messages that may explain something the Fusion page is trying to do in greater detail. The console is also where you can read FusionScript outputs or input FusionScripts directly. Occasionally, the status bar (described above) will display a badge to let you know there's a message in the console you might be interested in. The badge will indicate if the message is an error, log, or script message.
The Color Page

The Color page is where you color correct, or grade, your program. It has all of the controls available for manipulating color and contrast, reducing noise, creating limited secondary color corrections, building image effects of different kinds, adjusting clip geometry, and making many other corrective and stylistic adjustments. The Color page is divided into seven main areas that work together to let you build a grade.

For more detailed information about the Color page, see Chapter 124, “Using the Color Page.”
**Viewer**

The Viewer shows the frame at the current position of the playhead in the Timeline. The contents of the Viewer are almost always output to video via whichever I/O interface you have connected. At the top of the Viewer is a header that displays the Project and Timeline names, as well as a Viewer Timecode display that shows the source timecode of each clip by default. The Timeline name is also a drop-down display that lets you switch to any other timeline in the project. A jog bar (sometimes referred to as a scrubber bar) underneath the image lets you drag the playhead across the entire duration of the clip, while transport controls underneath that let you control playback. A toolbar at the top provides controls governing Image Wipes, Split-Screen controls, and Highlight display. Additional controls let you turn audio playback on and off, and choose which onscreen controls are currently displayed.

![Viewer with transport controls](image)

You can also put the Viewer into Cinema Viewer mode by choosing Workspace > Viewer Mode > Cinema Viewer (Command-F), so that it fills the entire screen. This command toggles Cinema Viewer mode on and off. Two other modes, Enhanced Viewer (Option-F) and Full Screen Viewer (Shift-F), are available to provide more working area for tasks such as window positioning and rotoscoping.

**Gallery**

The Gallery is used for storing still frames to use as reference when comparing clips to one another. Each still frame also stores that clip's grade so you can copy it later; stills and grades are stored together. A button lets you open up the Album browser, used for organizing your stills. At the top of the Gallery, Memories let you store grade information that you can apply using a control panel or keyboard shortcuts. You can also open a larger Gallery window within the Color page that provides more room for organizing your saved stills and grades. For more information on the Gallery page, see Chapter 138, “Using the Gallery.”

![The Gallery has Memories, stills saved in albums, and your PowerGrades](image)
Node Editor

The Node Editor is where you assemble one or more individual corrections (nodes) together to create multi-correction grades (seen as node trees). This is a powerful way of assembling grades, since different combinations of nodes let you create different corrections and very specific adjustments by reordering operations, combining keys, or changing the layer order of different adjustments. For more information about the Node Editor, see Chapter 140, “Node Editing Basics.”

Node Editor to construct your grade processing signal flow

Timeline

The Timeline in the Color page reflects the contents of the Timeline in the Edit page, but has a different appearance that’s tailored to the requirements of the colorist. However, the content is identical, and changes made to the Timeline in the Edit page are immediately seen in the Color page as you switch back and forth. The Color page Timeline provides several ways of navigating the clips in your project, as well as keeping track of what has been done to which clips.

The Timeline is divided into three parts, each of which shows different information and provides differing controls. A Timeline Ruler at the top lets you scrub the playhead across multiple clips, and can be zoomed out enough to show every clip in your entire program. Underneath, the Mini-Timeline (which can be opened or closed via a button at the right of the palette bar) shows a small representation of the Timeline in the Edit page wherein each clip is as long as its actual duration. At the bottom of the Timeline is the Thumbnail timeline, in which each clip is represented by a single frame. The currently selected clip is outlined in orange, and information appears above and below each thumbnail such as each clip’s source timecode, clip number and track number, version name, whether it’s been graded, whether it’s been tracked, if it’s been flagged, and so on.

The Color page Timeline
**Left Palettes**

A series of palettes at the bottom left of the Color page provide access to different sets of grading tools, used principally for manipulating color, contrast, and raw media format settings. Each individual palette is opened by clicking the corresponding icon at the top of the Palette panel.

The available palettes are the Camera Raw palette (for making metadata adjustments to raw media formats), the Color Match palette (for creating automatic grades by sampling on-camera color charts), the Color Wheels (graphical color balance controls and master wheels or sliders for adjusting YRGB Lift/Gamma/Gain), HDR Grade for enhanced High Dynamic Range grading, the RGB Mixer (for mixing color channels into one another), and the Motion Effects palette (with controls for noise reduction and artificial motion blur).

**Center Palettes**

At 1920x1080 resolution or higher, a second set of palettes is organized at the bottom center of the Color page. These palettes span a wide range of functionality, and the adjustments you make with them can be combined with those made using the Color palettes.

NOTE: At lower resolutions, the Left and Center palettes are merged to fit the DaVinci Resolve interface into a smaller area.

The eight available Center palettes include the Curves palette, the Color Warper palette, the Qualifiers palette, the Windows palette, the Tracker palette, the Magic Mask palette, the Blur palette, the Key palette, the Sizing palette, and the Stereoscopic 3D palette.

**Keyframe Editor**

The Keyframe Editor provides an interface for animating Color, Sizing, and Stereo Format adjustments over time. Each node in the Node Editor corresponds to a track in the Keyframe Editor, which lets you animate each node’s adjustments independently.
Furthermore, each node’s track can be opened up to reveal parameter groups, so that you can animate subsets of an individual node’s functions independently of other functions within the same node.

The Fairlight Page

In single monitor mode, the Fairlight page is an optimized look at the audio tracks of your project, with an expanded mixer and custom monitoring controls that make it easy to evaluate and adjust the levels of your program in order to create a smooth and harmonious mix.
About Audio Monitoring and Audio Input

The audio processing throughout DaVinci Resolve, including on the Fairlight page and audio processing using Fairlight FX plug-ins, is equally compatible with all platforms that DaVinci Resolve runs on, including macOS, Windows, and Linux.

DaVinci Resolve supports audio monitoring using

a. The audio of a supported Blackmagic Design I/O device such as an UltraStudio or Decklink.

b. Your macOS, Windows, or Linux workstation’s on-board audio.

c. Any Core Audio compatible, Windows compatible, or Advanced Linux Sound Architecture (ALSA)-supported third-party audio interface.

d. The Fairlight Audio Accelerator, MADI Upgrade and Fairlight Audio Interface

DaVinci Resolve supports audio input using the embedded audio on an incoming SDI video feed when capturing incoming A/V source, via system audio and also via the Fairlight Audio Accelerator, MADI Upgrade and Fairlight Audio Interface.

The Audio Timeline

The heart of the Fairlight page, the Audio Timeline presents the audio channels and tracks of the currently selected timeline differently than the Edit page does, in a one-channel-per-track format that’s optimized for audio mixing and sweetening. The Audio page Timeline cannot be closed.

The Fairlight page of DaVinci Resolve supports multiple audio tracks, and each audio track may contain multiple lanes. The clips edited into the Timeline appear within each track, with the recorded channels within each clip occupying as many lanes as that clip has available. At the left of each track is a header area that contains a number of controls.
Audio layering in a mono audio track

The Fairlight page differs in another unique respect from the Edit page Timeline, in that it supports audio layering. Audio layering is a special audio editing mode that lets you superimpose multiple audio clips in the same track, and whatever audio clip is on top dictates which audio will play. In a way, when audio layering is enabled, superimposed audio clips are treated the same as superimposed video clips that all have opacity set to 100%, with clips on top obscuring (or muting) clips underneath.

Audio layering is incredibly useful for any situation where you’re combining pieces of multiple takes together to create a single VO, audio vocal track, or dramatic performance, as you can choose which pieces to prioritize via their superimposed position in the track, while you’re preserving the other takes underneath in case you want them later.

**TIP:** Track Layering can be used on the Edit page as well.

Turning on Track Layers opens up space to edit more audio into each track

**Toolbar**

The toolbar has buttons that let you choose modes of audio-specific functionality and other buttons that let you execute commands, such as placing markers and flags.

**Mixer**

The Audio Mixer provides a set of graphical controls you can use to assign track channels to output channels, adjust EQ and Dynamics, set levels and record automation, pan stereo and surround audio, and mute and solo tracks, all while you continue to edit.

The Audio Mixer exposes a set of channel strips with controls that correspond to the tracks in the Timeline, one for each track, plus a Master strip corresponding to the Master audio track in the Timeline, that lets you choose the number of audio channels to output, and also lets you adjust the overall level of the mix.
The Audio Mixer, with channel strips corresponding to the tracks in the Timeline

Dedicated Channel Strip Controls

The Mixer also has a series of dedicated channel strip controls that add powerful mastering capabilities to DaVinci Resolve. These include:

- **EQ**: Double-clicking exposes a four-band parametric equalizer with additional Hi and Lo Pass filters, that has both graphical and numeric controls for tuning the frequencies of the audio on each track. You can select from among four types of EQ filtering from the Equalizer Type dropdown menu, with options for Earth (the default), Air, Ice, and Fire. Each band has controls for the filter type (Bell, Lo-Shelf, Hi-Shelf, Notch), Frequency, Gain, and Q-factor (sharpness of the band).
– **Dynamics:** Double-clicking exposes a set of dynamics controls with compressor, limiter, and expander or gate sections. The Equalizer button at the upper left-hand corner lets you turn all EQ on and off. The first section can be switched between working as an Expander or a Gate, with attendant Threshold/Range/Ratio and Attack/Hold/Release controls. The second section provides Compressor controls, while the third section provides Limiter controls. These controls may be used either singly or in concert to manage the dynamics of the audio on that track.

The channel strip Dynamics control window

– **Pan:** A pan control compatible with stereo and surround panning. You can drag within this control to adjust pan, or you can double-click to expose a Pan window. What controls are available in the Pan window depend on the mapping of the audio track, but both stereo and surround panning controls are available, with corresponding numeric controls.

The Pan control window
The Monitoring Panel

The Monitoring panel shows all of the audio meters corresponding to the tracks in the Timeline, as well as the Master Output meter, Control Room meters, and a video viewer.

At left, a row of audio meters corresponds to the channel strips of the Mixer, one meter for every audio track in the Timeline. To the right of these, all buses appear, showing you meters for the Mains and Subs (submixes) you’re using to mix down your show. Farther to the right of these, a set of Control Room meters show you the monitored output and loudness meters for a precise analysis of your mix’s perceived loudness.

Finally, a small viewer to the right of the Monitoring panel shows the frame of video at the position of the playhead. This viewer can be undocked via a button at the lower right-hand corner.

Floating Timecode Window

A timecode window is available from the Workspace menu on every page, including the Fairlight page. Choosing this option displays a floating timecode window that shows the timecode of the Viewer or Timeline that currently has focus. This window is resizable so you can make the timecode larger or smaller.

The Deliver Page

Once you’ve finished grading your project, you need to either render it, or output it to tape to deliver it to your client. This is where the Deliver page comes in. The Deliver page can be used both to output digital deliverables, or to output tape, depending on which mode you enable. Either way, the Deliver page is divided into five areas of functionality, each of which lets you set up a different part of a render or output to tape.

The Deliver page is set up to let you queue a series of individual jobs, each of which can have different settings, or be set up to render different parts of the Timeline. In this way, you can output multiple deliverables, or re-render multiple areas of a timeline, as your needs require.
For more information about using the Deliver page, see Chapter 185, “Using the Deliver Page.”

The Render Settings List

The Render Settings list contains the customizable settings that affect how media is rendered out of DaVinci Resolve. These settings are covered in more detail later in “Output Scaling.” The Render Settings you can choose from for outputting from DaVinci Resolve appear in three panels, separating the Video, Audio, and File information-based settings in a logical fashion. By default, this list shows only the most important criteria necessary for defining a render. However, additional controls can be exposed by clicking the “Advanced settings” disclosure triangle at the bottom of each group of settings.
The Deliver Page Timeline

The Timeline mirrors the Timeline seen in the Color page. You can use the Timeline in the Deliver page to turn off tracks with clips you don’t want to include in the operation, define the range of clips you want to render or output to tape, and to choose which versions for each clip you want to output. You also have the option of switching the Deliver page Timeline to look like the Color page Timeline instead, if that’s what you’re more comfortable with.

The Deliver page’s Thumbnail and Mini-Timeline match the Color page

The Deliver page Timeline also has the Timeline Filter drop-down at the right-hand side of the toolbar. Using this drop-down to filter the contents of the Timeline lets you restrict the range of media you want to output in different ways. For example, if you’ve already rendered a timeline, but you’ve since made some changes, you can use the “Show Modified Clips” option to display only the clips that have changed within a particular timeframe. Another possibility is to choose the “Show Unrendered Clips” option to show all clips that have not yet been rendered.

The Viewer

When rendering file-based media, the Viewer shows you exactly how the media being output will look using the current settings, and the transport controls move the playhead throughout the current Timeline.

Deliver page Viewer

When outputting to tape, the Viewer shows you the tape output so you can set up insert or assembly edit points, and the transport controls move the tape in the deck if device control is enabled. You can also put the Viewer into Cinema Viewer mode by choosing Workspace > Viewer Mode > Cinema Viewer (Command-F), so that it fills the entire screen. This command toggles Cinema Viewer mode on and off.
The Render Queue

The Render Queue is a list of all the jobs you’ve queued up for file-based rendering. Each job can have an individualized range of clips and render settings, which you can use to render multiple sections or clips of a timeline, the same timeline output to multiple formats, or multiple timelines.

The Render Queue also has the option to show either just the jobs within the current project, or jobs queued up and saved within all projects for the current user.
Chapter 2

Using the DaVinci Resolve User Interface

This chapter provides an overview of the various unspoken conventions and interaction methods employed by the DaVinci Resolve graphical user interface (GUI). These include how the various buttons of your mouse, pen and tablet, or trackpad are used by different windows and interface widgets, how commands are distributed throughout the application using the menu bar, contextual menus, and option menus, and how to interact with fields and other controls. While many of these conventions overlap with common user interface conventions found in the file system of your platform of choice, and with other media applications, some of these are unique to DaVinci Resolve, so this chapter is worth reviewing even if you consider yourself an expert user of other applications.

Contents

Basic Documentation Terminology 50
What Is the “UI” or “GUI” 50
What Is “the Pointer” 50
About Keyboard Shortcuts 50
Customizing the DaVinci Resolve Interface 51
Working Full Screen vs. Within a Floating Window 51
Panels and Panel Focus 51
Showing and Hiding Panels Using the Interface Toolbar 52
Showing and Hiding Panels in the Workspace Submenu 53
Basic Documentation Terminology

Here is a brief word about some of the basic terminology used in this manual for brand new users.

What Is the “UI” or “GUI”

In this documentation, UI refers to “user interface,” while GUI refers to “graphical user interface.” This refers to the windows, screens, and controls that let you create in DaVinci Resolve. If you didn’t know this, don’t be embarrassed, you’d be surprised how many times this question gets asked.

What Is “the Pointer”

Whenever this documentation refers to “the pointer,” the reference is to the on-screen arrow you use to click on elements of the user interface, which is controlled by the mouse, trackpad, pen and tablet, trackball, or any other device you may be using. Because there are so many different ways to control computers, simply referring to “the mouse” is inaccurate.

About Keyboard Shortcuts

Since the majority of DaVinci Resolve users currently appear to be on macOS, this manual presents all keyboard shortcuts using the macOS conventions of the Command key and the Option key. For compatibility with Windows and Linux, the Control key in macOS is not used by default for any keyboard shortcuts (although it can be assigned if you customize your keyboard shortcuts).

All keyboard shortcuts that use the Option key in macOS use the ALT key in Windows and Linux, and all keyboard shortcuts that use the Command key in macOS use the Control key in Windows and Linux.
Customizing the DaVinci Resolve Interface

While the DaVinci Resolve interface may not seem very customizable at first, there are actually many ways in which you can tailor the panels found within each page to your specific needs.

Working Full Screen vs. Within a Floating Window

Depending on how you like to work, you can choose to work with DaVinci Resolve in a floating window with a title bar that can be resized, moved, minimized, and used alongside other windows. Or, you can choose Workspace > Full Screen to put DaVinci Resolve into Full Screen mode, where the title bar disappears and DaVinci Resolve takes up the full dimensions of your computer display.

Editors may prefer to work within a window if they’re working among multiple applications. Colorists and mixers may prefer Full Screen mode as it hides the light-colored title bar that some find distracting and provides a tiny bit more screen real estate for the rest of the application.

Panels and Panel Focus

Each page of DaVinci Resolve consists of multiple panels. Each panel contains all the controls and information necessary for a particular aspect of that page’s functionality. In the following partial screenshot of the top of the Media page, the Media Storage panel lets you browse files, the Viewer is a panel that lets you watch video, and the Audio panel lets you see the strength of audio playing back via a set of audio meters. Each of these panels has separate controls, but they all appear within the main window of the DaVinci Resolve user interface.

Three panels side by side on the Media Page, showing Media Storage, the Viewer, and the Audio panel

Each panel you use has “focus,” meaning that clicking an item or control within a particular panel makes that panel the active panel, which serves to direct keyboard shortcuts that are shared among many panels to the particular panel you’re using. If you want to see which panel is in focus, you can turn on the “Show focus indicators in the User Interface” checkbox in the UI Settings panel of the User Preferences. When on, a red line at the top of the active panel indicates that it has focus.
Showing and Hiding Panels Using the Interface Toolbar

Each page in DaVinci Resolve has an Interface Toolbar that runs along the top. This toolbar contains buttons that let you show and hide different panels of functionality to accomplish different things:

- You can show panels that aren’t displayed by default, since most pages have many available panels of functionality that are hidden until you need them.
- You can assign keyboard shortcuts to show and hide individual panels in your workspace for instant configuration of the UI. Keyboard shortcuts to toggle these panels on or off can be assigned using the Keyboard Customization window.
- You can switch which panel appears within a particular geographical location of the UI, for example switching between showing the Media Pool or Effects in the upper-lefthand corner of the Cut or Edit pages.
- You can hide panels you don’t need in order to create more room in the specific panels you’re working within.

If you right-click anywhere within the UI toolbar, two options appear: “Show Icons and Labels” and “Show Icons Only.” If you show icons only, the UI toolbar becomes less cluttered.

Each page has a different set of options that reflect the capabilities of that page.
Showing and Hiding Panels in the Workspace Submenu

This function provides the ability to turn on or off panels by choosing them in the Workspace > Show Panel in Workspace drop-down menu. The exact panels, such as Inspector, Media Pool, Metadata, etc., are dependent on which page you are working in. Alternatively, you can assign these panels keyboard shortcuts as well.

Adjusting the Size of Different Panels

You can resize adjacent panels in the interface by positioning the pointer at the border between any two panels, and dragging it to enlarge one and shrink the other.

Certain panels and palettes can be expanded, in the process rearranging another part of the UI, by clicking a small gray Expand button. For example, an expand button at the top right of the Keyframe Editor in the Color page can be clicked to make the Keyframe Editor wider, while at the same time hiding controls at the center to make room.

Certain vertically oriented panels, such as the Media Pool, Effects Library, Metadata Editor, and Inspector, can be set to either half-display-height or full-display-height sizes to quickly create more or less room for contents or controls whenever necessary. This is done by clicking a small button in the UI toolbar that toggles between expanding or contracting the UI element it controls.
The result is that the panel in question expands or contracts. The following screenshots show the Inspector of the Edit page in half height mode, where the Timeline is given room to expand, and in full height mode, where the Timeline becomes shorter, but there’s more room in the Inspector to see all of the controls.

(Left) A half-height Inspector with more room for the Timeline. (Right) A full-height Inspector with more room for controls.

Using Single vs. Dual Monitor Layouts

The Media, Edit, Color, and Fairlight pages can be switched between single screen and dual screen layouts by choosing Workspace > Dual Screen > On. Each dual-screen layout makes it possible to see many more controls at once, often in a larger workspace that lets you manage more clips, more Gallery stills, etc.
In Single-screen mode, you can choose which display shows the DaVinci Resolve UI by choosing Workspace > Primary Display > (Monitor Name). In Dual-screen mode, this reverses the contents of both monitors.

Using the Full Screen Timeline Option in the Edit Page

If you’re working in the Edit page in Dual-screen mode and you need the biggest timeline you can get for working through your program, you can choose Workspace > Dual Screen > Full Screen Timeline to expose a layout with one large full screen timeline, and all the other Edit page panels on the other screen.
The Edit page in Dual-screen Timeline mode

**Video Clean Feed**

A full screen Viewer for a secondary monitor connected directly to your computer is now available. To activate this monitor select Workspace > Video Clean Feed, and select your display in the submenu.

Selecting a secondary monitor for full screen display
Saving Custom Screen Layouts

If you’ve created a particular set of resized panels that you’ll want to use often, you can save it, alongside other frequently useful screen layouts you may have saved.

Methods of working with custom screen layouts:

– **To save a custom screen preset:** Customize the various pages of DaVinci Resolve for the purpose at hand, then choose Workspace > Layout Presets > Save Layout As Preset. Enter a name into the Save Layout as Preset dialog, and click OK.

– **To choose a previously saved screen preset:** Choose Workspace > Layout Presets > LAYOUT NAME > Load.

– **To update a previously saved screen preset:** Choose the layout you want from the Workspace > Layout submenu, make your changes, and then choose Workspace > Layout Presets > LAYOUT NAME > Update Preset.

– **To delete a screen preset:** Choose Workspace > Layout Presets > LAYOUT NAME > Delete Preset.

– **To export a screen preset for use on another DaVinci Resolve installation:** Choose Workspace > Layout Presets > LAYOUT NAME > Export Preset.

– **To import a screen preset:** Choose Workspace > Layout Presets > Import Layout as Preset.

Resetting to the Default Layout

If you don’t like the current layout and you want to go back to the default, choose Workspace > Reset UI Layout.

Undocking Specific Panels of the Interface

There are certain interface elements that can either be docked in their respective pages, or opened in separate windows.

Media Pool bins can be opened into floating windows simply by right-clicking on the bin and choosing Open As a New Window in the contextual menu. Even though you’re opening up the contents of the selected bin, you’re really creating another Media Pool, complete with Bin list, Browsing area, and all of the organizational controls found in the docked Media Pool. You can have as many floating Media Pools as you like. They can be dragged to other monitors, and they can be closed via a button at the upper left-hand corner of the title bar.
The video scopes let you precisely analyze the color and contrast of clips in the Color page. They can be exposed in their docked position to the right of the Color page palettes by clicking the Video Scope button in the Color page toolbar.

The video scope, docked next to the other palettes at the bottom of the Color page

Optionally, you can click the expand button at the top right of the video scope to open the video scopes into a floating window, within which you can display all four video scopes together, or individually, on any monitor connected to your workstation.

Video scopes in a floating window

Additionally, the Audio Mixer and video scopes are available in many of the dual-screen layouts available in DaVinci Resolve. The video scopes aren’t just available in the Color page. They’re also available in the Media and Deliver pages for whenever you need to evaluate the video signal more objectively, such as when you’re setting up to capture from tape or scan from film, or when you’re setting up for output.

In the DaVinci Resolve single screen layout, the Audio Mixer and video scopes can be moved to a second computer display if one’s available, and both disappear temporarily if you change pages or switch to another application.
DaVinci Resolve User Interface Conventions

While each chapter covers the unique onscreen controls found in each page of DaVinci Resolve, this section summarizes how to use some of the more common controls you’ll see.

Contextual Menus

Nearly every panel on every page exposes additional functionality via contextual menus, which appear when you right-click on the appropriate item. Sometimes, different commands become available depending on whether you right-click the background of a particular panel, or directly on an item such as a still or node.

Drop-down Menus

Most of the buttons and drop-down menus that appear in various toolbars are activated with a single click. For example, many panels, palettes, and windows expose an Option menu, that appears as three horizontal dots (people like to refer to these as the “three dot menus,” but they’re option menus), which expose additional options and/or commands that are related to that particular panel’s function.
Additionally, many (but not all) panels and palettes appear with a "Mode" drop-down at the upper right-hand corner that lets you choose a different type of function within that palette.

Some buttons, such as transport controls and toolbar icons, display a little downward facing arrow when you hover the pointer over them, to indicate that you can right-click on these controls to access checkmark options that govern the functionality of those controls.

Adjusting Parameters

Numeric parameters can usually be edited in a few different ways.

Sliders and Dials

Sliders can be dragged to change the value of a parameter within a specific range. If you see a dial, that means a value can be endlessly edited with no restrictions to the value. Sliders are typically best for making large coarse adjustments to parameters. The "virtual sliders" described next let you make finer adjustments.

Virtual Sliders and Fields

When number fields appear, they can be used as a "virtual slider" by hovering the pointer over them until you see the "virtual slider cursor" and then clicking and dragging to the right to raise the value, or to the left to lower the value (white arrows indicate the direction of change). Typically, using a field's virtual slider lets you make more precise adjustments than the actual slider to the left.
Using virtual sliders

Double-clicking fields containing most number values highlights the number so that you can type a new value using the keyboard, pressing Return to confirm the change.

Editing of Number Field Values Using Arrow Keys

You can manually edit numerical parameter values by using the arrow keys to navigate and make adjustments to the decimal level in number fields.

To use the arrow keys to adjust numerical parameters:

1. Double-click to select a numeric value in a field, and a highlight appears around that value.
2. Use the left/right arrows to navigate the cursor to the right of the decimal value you want to adjust.
3. Use the Up/Down arrows to change the value of that decimal place.
4. If you select the entire number, the Up/Down arrows will adjust the minimum value.

Icons and Buttons

Some controls are exposed as icons and buttons, which you simply click to invoke whatever functionality they encompass.

Resetting Parameters

To reset any editable parameter to its default setting, double-click its text label, or click the reset button, if one appears. Master reset buttons, typically found in the headers of groups of controls, reset all controls in that group. Individual reset controls that appear to the right of parameters typically only reset that one parameter. If you don’t see a reset control, then double-clicking the name of the parameter should work.
Using a Mouse or Other Input Device

Resolve uses all three buttons of a multi-button mouse, or the three buttons available on other type of input devices, when available. This section provides a brief summary of all the different ways these three mouse buttons can be used.

Left Button
The left button is always referred to as a click, as in, “click the auto select button.” You click to turn buttons or other controls on or off, to make selections, and to give areas of the Resolve UI focus so that keyboard shortcuts will do whatever is specific to that panel or area of the user interface.

Double-clicking the left button usually opens items that are openable, such as opening a clip from the Media Pool into the Source Viewer. You can also use double-clicking to do things like selecting nodes in the Node Editor of the Color page.

Right Button
The right button is referred to as a right-click, as in, “right-click a clip in the Media Pool.” Right-clicking an item or area of the Resolve interface usually opens a contextual menu, exposing additional commands that are specific to the item or area you’ve right-clicked.

However, some areas of the UI use right-clicking in special ways. For example, when you’re using a color adjustment curve in the Curve palette of the Color page, right-clicking a control point deletes that point.

Middle Button
The middle button (usually the scroll wheel button, but you may have to turn this on in the Mouse panel of the System Preferences) is referred to as a middle-click, which does different things in different places.

– In all pages, rolling the scroll wheel while the pointer is within a viewer lets you zoom into and out of the image being displayed when you need to do more detailed work.
– In the Color page, you can move the pointer over the Thumbnail timeline and roll up to scroll to the right or roll down to scroll to the left. You can also roll the scroll wheel while the pointer is within the Mini-timeline to zoom into or out of the currently displayed area. Rolling up zooms out, while rolling down zooms in.
– Middle-clicking and dragging within a viewer lets you drag the image to pan it around, which is useful after you’ve used the scroll wheel (or scroll behavior) of your mouse to zoom in.
– You can middle-click and drag within the Edit page Timeline to quickly pan around your edit.
– You can also use middle-click to copy a grade in the Thumbnail timeline of the Color page, by first selecting the clip that you want to copy TO (with a simple click) and then middle-clicking the clip or gallery still you want to copy a grade FROM.
– Lastly, if you’re drawing a Bezier window in the Color page Viewer using the Window palette, then middle-clicking a control point will delete that point.

TIP: If you’re using a pointing device that lacks a third button option, check to see if there are any third party utilities or drivers that can enable this for you.
Mouse, Trackpad, and Tablet Behaviors

Different input devices use different gestures to trigger specific behaviors in DaVinci Resolve. Here is a current breakdown of these gestures and the behaviors that they control.

### Timeline Scroll Behavior

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Standard Mouse</th>
<th>Mac Magic Mouse</th>
<th>Trackpad</th>
<th>Tablet and Pen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll timeline vertically</td>
<td><img src="image" alt="Scroll" /></td>
<td><img src="image" alt="Magic Mouse 1 Finger Pan" /></td>
<td><img src="image" alt="Trackpad" /></td>
<td><img src="image" alt="Pen" /></td>
</tr>
<tr>
<td>Scroll timeline horizontally</td>
<td><img src="image" alt="Scroll" /></td>
<td><img src="image" alt="Magic Mouse 1 Finger Pan" /></td>
<td><img src="image" alt="Trackpad" /></td>
<td><img src="image" alt="Pen" /></td>
</tr>
<tr>
<td>Zoom timeline width horizontally</td>
<td><img src="image" alt="Option" /></td>
<td><img src="image" alt="Magic Mouse 1 Finger Pan" /></td>
<td><img src="image" alt="Trackpad" /></td>
<td><img src="image" alt="Pen" /></td>
</tr>
<tr>
<td>With ability to zoom where cursor points Can be enabled in User Workspace Prefs</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom timeline track height vertically</td>
<td><img src="image" alt="Shift" /></td>
<td><img src="image" alt="Magic Mouse 1 Finger Pan" /></td>
<td><img src="image" alt="Trackpad" /></td>
<td><img src="image" alt="Pen" /></td>
</tr>
<tr>
<td>Zooms Video and Audio section separately</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drag Timeline with Hand Tool</td>
<td><img src="image" alt="Middle Button" /></td>
<td><img src="image" alt="Middle Button and Click Drag" /></td>
<td><img src="image" alt="Pinch and 2 Finger Pan" /></td>
<td><img src="image" alt="Press and hold the pen button" /></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Viewer Behavior

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Standard Mouse</th>
<th>Mac Magic Mouse</th>
<th>Trackpad</th>
<th>Tablet and Pen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom</td>
<td><img src="image" alt="Scroll" /></td>
<td><img src="image" alt="Middle Button and Click Drag" /></td>
<td><img src="image" alt="Pinch and 2 Finger Pan" /></td>
<td><img src="image" alt="Press and hold the pen button" /></td>
</tr>
<tr>
<td>Can be enabled in User Workspace Prefs</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Free Pan</td>
<td><img src="image" alt="Scroll" /></td>
<td><img src="image" alt="Magic Mouse 1 Finger Pan" /></td>
<td><img src="image" alt="2 Finger Pan" /></td>
<td></td>
</tr>
<tr>
<td>Pan with Hand Cursor</td>
<td><img src="image" alt="Scroll" /></td>
<td><img src="image" alt="Magic Mouse 1 Finger Pan" /></td>
<td><img src="image" alt="2 Finger Pan" /></td>
<td></td>
</tr>
<tr>
<td>Pan Up and Down</td>
<td><img src="image" alt="Scroll" /></td>
<td><img src="image" alt="Magic Mouse 1 Finger Pan" /></td>
<td><img src="image" alt="2 Finger Pan" /></td>
<td></td>
</tr>
<tr>
<td>Pan Left and Right</td>
<td><img src="image" alt="Scroll" /></td>
<td><img src="image" alt="Magic Mouse 1 Finger Pan" /></td>
<td><img src="image" alt="2 Finger Pan" /></td>
<td></td>
</tr>
<tr>
<td>Context Menu</td>
<td><img src="image" alt="Right Button" /></td>
<td><img src="image" alt="Middle Button and Click Drag" /></td>
<td><img src="image" alt="Pinch and 2 Finger Pan" /></td>
<td></td>
</tr>
</tbody>
</table>

Gestures used in DaVinci Resolve for common input devices.
Keyboard Shortcuts

Since the majority of DaVinci Resolve users are on macOS, this manual presents all keyboard shortcuts using the macOS conventions of the Command key and the Option key. For users of other systems, all keyboard shortcuts that use the Option key in macOS use the ALT key in Windows and Linux, and all keyboard shortcuts that use the Command key in macOS use the Control key in Windows and Linux.

**TIP:** To keep controls identical between macOS, Windows, and Linux, the Control key in macOS is not used by default for any keyboard shortcuts. However, you can assign your own keyboard shortcuts to the Control key if you like, opening up a whole new set of keyboard shortcuts for your own use on macOS.

Undo and Redo in DaVinci Resolve

No matter where you are in DaVinci Resolve, Undo and Redo commands let you back out of steps you’ve taken or commands you’ve executed, and reapply them if you change your mind. DaVinci Resolve is capable of undoing the entire history of things you’ve done since creating or opening a particular project. When you close a project, its entire undo history is purged. The next time you begin work on a project, its undo history starts anew.

Because DaVinci Resolve integrates so much functionality in one application, there are three separate sets of undo “stacks” to help you manage your work.

- The Media, Edit and Fairlight pages share the same multiple-undo stack, which lets you backtrack out of changes made in the Media Pool, the Timeline, the Metadata Editor, and the Viewers.
- Each clip in the Fusion page has its own undo stack, so that you can undo changes you make to the composition of each clip, independently.
- Each clip in the Color page has its own undo stack, so that you can undo changes you make to grades in each clip, independently.

In all cases, there is no practical limit to the number of steps that are undoable (although there may be a limit to what you can remember). To take advantage of this, there are three ways you can undo work to go to a previous state of your project, no matter what page you’re in.

**To simply undo or redo changes you’ve made one at a time:**

- Choose Edit > Undo (Command-Z) to undo the previous change.
- Choose Edit > Redo (Shift-Command-Z) to redo to the next change.
- On the DaVinci control panel, press the UNDO and REDO buttons on the T-bar panel.

**TIP:** If you have the DaVinci control panel, there is one other control that lets you control the undo stack more directly when using the trackballs, rings, and pots. Pressing RESTORE POINT manually adds a memory of the current state of the grade to the undo stack. Since discrete undo states are difficult to predict when you’re making ongoing adjustments with the trackball and ring controls, pressing RESTORE POINT lets you set predictable states of the grade that you can fall back on.
You can also undo several steps at a time using the History submenu and window. At the time of this writing, this only works for multiple undo steps in the Media, Cut, Edit, and Fairlight pages.

**To undo and redo using the History submenu:**

1. Open the `Edit > History` submenu, which shows (up to) the last twenty things you’ve done.
2. Choose an item on the list to undo back to that point. The most recent thing you’ve done appears at the top of this list, and the change you’ve just made appears with a check next to it. Steps that have been undone but that can still be redone remain in this menu, so you can see what’s possible. However, if you’ve undone several changes at once and then you make a new change, you cannot undo any more and those steps disappear from the menu.

Once you’ve selected a step to undo to, the menu closes and the project updates to show you its current state.

**To undo and redo using the Undo window:**

1. Choose `Edit > History > Open History Window`.
2. When the History dialog appears, click an item on the list to undo back to that point. Unlike the menu, in this window the most recent thing you’ve done appears at the bottom of this list. Selecting a change here grays out changes that can still be redone, as the project updates to show you its current state.

3. When you’re done, close the History window.
Setup and Workflows
This chapter covers how to use the Project Manager to organize the projects you’re working on in DaVinci Resolve, as well as how to deal with managing the databases that serve as the organizational foundation of the Project Manager. You’ll also see how to export and import projects, and how to archive a project and its media for long-term storage.

## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Project Manager</td>
<td>68</td>
</tr>
<tr>
<td>Project Management</td>
<td>69</td>
</tr>
<tr>
<td>Importing DaVinci Resolve Projects (.DRP Files)</td>
<td>69</td>
</tr>
<tr>
<td>Project Manager View Options</td>
<td>70</td>
</tr>
<tr>
<td>Searching for Projects</td>
<td>71</td>
</tr>
<tr>
<td>Organizing Projects in Folders</td>
<td>72</td>
</tr>
<tr>
<td>Managing Databases with the Databases Sidebar</td>
<td>72</td>
</tr>
<tr>
<td>Opening the Databases Sidebar</td>
<td>73</td>
</tr>
<tr>
<td>Moving Projects From One Database to Another on the Same Workstation</td>
<td>73</td>
</tr>
<tr>
<td>Managing Databases in the Databases Sidebar</td>
<td>74</td>
</tr>
<tr>
<td>Legacy User Organization in the Databases Sidebar</td>
<td>78</td>
</tr>
<tr>
<td>Saving Projects</td>
<td>79</td>
</tr>
<tr>
<td>Live Save</td>
<td>79</td>
</tr>
<tr>
<td>Project Backups</td>
<td>80</td>
</tr>
<tr>
<td>Project Notes</td>
<td>82</td>
</tr>
<tr>
<td>Dynamic Project Switching</td>
<td>82</td>
</tr>
<tr>
<td>Archiving and Restoring Projects</td>
<td>83</td>
</tr>
</tbody>
</table>
Using the Project Manager

Ordinarily, the Project Manager is the first window you’ll see when DaVinci Resolve starts up. It’s a convenient, centralized browser for creating, organizing, and managing all of your projects. Unlike other applications that rely on your file manager for organizing projects, DaVinci Resolve requires you to do most project organization in the Project Manager.

If you’ve already opened a project, you can reopen the Project Manager at any time by clicking the Home button at the bottom right-hand corner of the DaVinci Resolve window, in the Page Navigation bar. If you’ve hidden the Page Navigation bar at the bottom of the DaVinci Resolve window, you can open the Project Manager by choosing File > Project Manager.

Launching DaVinci Resolve for the First Time?

If you’ve just installed DaVinci Resolve and have opened it for the first time, it’s time to set the preferences in order to specify your language, scratch disk volume, and hardware configuration for video and audio I/O and control panels (if you have one). For more information about setting the preferences in DaVinci Resolve, see Chapter 4, “System and User Preferences.”
Project Management

The Project Manager provides an in-application interface for creating, renaming, and deleting projects. Many of these commands exist within the contextual menu that appears when you right-click the background of the Project Manager.

Methods of project management:

– **To create a new project:** Double-click the Default Project icon, or click the New Project button at the bottom of the window. A new project is created, and DaVinci Resolve opens up the Media page. Once a project is open, you can alter its project settings by clicking the gear icon.

– **To open a previously saved project:** Double-click any Project icon, or Item if you’re in List view. You can also select a project and click the Open button.

– **To open a project in Read-Only Mode:** Right-click a Project icon or Item, and choose Open in Read Only Mode. This lets you open a project without danger of altering it. If you make changes, you can use the Save As command to save a new copy of the project with a new name.

– **To rename a project:** Right-click a Project icon or Item, choose Rename, and type a new name in the dialog that appears, clicking OK when you’re finished.

– **To load project settings from another project to the currently open project:** Right-click a Project icon or Item (other than the currently open project), and choose “Load Project Settings to Current Project.” This lets you change a project’s settings prior to opening it in cases where the project settings are causing some kind of problem that prevents you from opening the project.

– **To update the thumbnails of a project in the Project Manager:** Right-click any project, and choose “Update Thumbnails.”

– **To delete a project:** Select one or more projects, then either press the Backspace key, or right-click one of the selected projects and choose Delete. Click OK when a dialog asks you to confirm the operation.

**NOTE:** You cannot move or delete the currently open or loaded project.

Importing DaVinci Resolve Projects (.DRP Files)

DaVinci Resolve projects are saved with the file extension .drp and enable you to exchange files with other DaVinci Resolve users. If you double-click a DaVinci Resolve .drp file in the Windows or macOS file system, this will automatically open DaVinci Resolve, import that project into the Project Manager regardless of what kind of database you’re using, and open that project so that you’re ready to work.

Importing and Exporting Projects in Disk Databases

If you’re using Disk Databases to manage your projects, you can copy and import projects using the project folders in the file manager of either macOS or Windows. This method does not work for DaVinci Resolve on Linux.

Moving projects from one disk database into another using macOS or Windows:

1. Locate the disk database directory in which the project you want to copy is stored. If you don’t know where the designated disk database directory is, you can open DaVinci Resolve and check the directory path for the current disk database in the Databases sidebar.

2. Copy the project folder from the source workstation to the designated disk database directory on the destination workstation. If you don’t know where the designated disk database directory is, you can open DaVinci Resolve on the workstation you’re copying the project to and check the directory path for the current disk database in the Databases sidebar.
3 Once you’ve copied the project folder into the correct location, you’ll need to quit and reopen DaVinci Resolve. Afterwards, the imported project should appear in the Project Manager.

Importing and Exporting Projects in PostgreSQL Databases

If you’re using a PostgreSQL database, another set of commands let you import and export projects using the .drp file format. You can also export .drp files from Disk Databases if you want to export a more self-contained item to transport.

To import a .drp project file, do one of the following:
– Drag the .drp file you want to import from your file system and drop it anywhere into the Project Manager window.
– Right-click any empty area of the Project Manager and choose Import, then find and select a .drp project file using the Import Project File dialog, and click Open.

To import a .drp project file and reconfigure the gallery path at the same time:
– Hold the Option key down while right-clicking any empty area of the Project Manager, and choose Import+, then find and select a .drp project file, and click Open. Upon opening, the gallery path will automatically be updated to that of your workstation.

To export the currently open project as a .drp file:
– Choose File > Export Project, and when the Save dialog appears, choose a location, enter a name, and click Save. The result is a self-contained file with a .drp file suffix saved at the location you chose.

To export a .drp project file from the Project Manager:
1 Right-click a Project icon or Item in the Project Manager, then choose one of the following commands:
   – Export: Exports project data, with no LUTs and no stills. Best when you need to export the smallest possible file.
   – Export With Stills and LUTs: Exports the project including both still frames in the Gallery and LUTs used in grades. Best when you want to export the most self-contained file and you can’t guarantee the recipient will have the same LUTs you do.
2 When the Save dialog appears, choose a location, enter a name, and click Save. The result is a self-contained file with a .drp file suffix saved at the location you chose.

Project Manager View Options

Four buttons at the top right let you control how projects are viewed in the Project Manager.

Select Thumbnail or List View

– Zoom slider: (Only appears in Thumbnail view) Lets you adjust the size of the thumbnails in Thumbnail view.
– Project Sort Order drop-down: (Only appears in Thumbnail view) Lets you choose the sort order of projects in Thumbnail view.
– Information: (Only appears in Thumbnail view) Lets you show or hide additional project information displayed underneath each project’s thumbnail, including the frame size, number of timelines within, and when that project was last modified.
– **Thumbnail view:** Each project is represented by a large image that can be hover-scrubbed to reveal five representative images from that project.

![Pool Shark Finish](image)

Hover-scrub over Project icon; information is enabled

– **List view:** Every project appears as an item in a list that has seven columns: Name, Last Modified, Timelines, Format, Frame Rate, Date Created, and Note. You can click any column header to sort the contents of the Project Manager by that criteria; clicking the header a second time toggles that column between ascending and descending sorting.

![Project List view](image)

### Searching for Projects

Clicking the magnifying glass button at the upper right-hand corner of the Project Manager exposes the Search Options, which can be used to locate one or more projects based on the metadata that’s selected in the Filter By drop-down menu to the right of it.

![Search field open with Filter by search criteria selected](image)
Using the drop-down menu, you can choose to search by name, or by project format. Once you’ve chosen a criteria, begin typing into the search field, and the Project Manager will immediately and dynamically begin to be filtered by your search text.

**Organizing Projects in Folders**

If you’re organizing a lot of projects, you can create folders to put them into.

![A folder in the Project Manager](image)

**Methods of working with project folders:**

- **To create a folder:** Click the New Folder button, then enter a name into the Create New Folder dialog and click Create.

- **To delete a folder:** Right-click a folder, choose Delete, and click Yes when prompted. All projects inside a deleted folder will be deleted as well.

- **To rename a folder:** Right-click a folder, choose Rename, then enter a new name and click OK.

- **To open a folder:** Double-click a folder to open it and view its contents. At the upper left-hand corner of the Project Manager, a folder path view shows you which folder is open, as well as where you are within a nested series of folders if that’s what you’ve set up.

- **To exit a folder:** Use the path control at the bottom left of the Project Manager.

- **To move a project into a folder:** Drag the project onto a folder icon, and drop it to place it inside the folder.

- **To move a project out of a folder:** Open a folder, select one or more projects you want to move, then right-click the selection and choose Cut from the contextual menu. Then, navigate to the next place in the Project manager where you want to place the cut projects, right-click the background of the Project Manager, and choose Paste. The projects should appear in the new location.

**Managing Databases with the Databases Sidebar**

Unlike other applications which save self-contained project files to user-specified locations wherever you like in your file system, DaVinci Resolve takes a more centrally organized approach to project management, using databases. By default, DaVinci Resolve uses a disk database to keep track of every project you create. The Database sidebar lets you manage the projects found within this database, which are saved to a specific directory on your system (particular to that database). The default location of this disk database depends on the operating system you use.

However, you can create additional databases with which to store other projects, if you like. For example, you might create one database each for each year in which you work. If you work on series television, you could create multiple databases for each program you work on. Or, you could create separate databases for each client you do work for. There’s no hard and fast rule; ultimately how you use databases is entirely up to you and your individual organizational preferences.
**TIP:** However you elect to organize your databases, keep in mind that projects saved within smaller databases with less project data will load and save faster.

### Opening the Databases Sidebar

If you already have multiple databases, then clicking the button at the upper-left hand corner of the Projects Browser reveals a sidebar at the left of the Project Manager that lists every database on your workstation, with various options for managing these databases and for browsing the projects found within them.

You can use this sidebar to open different databases and browse the projects found inside.

### Moving Projects From One Database to Another on the Same Workstation

If you’ve used multiple databases to organize your projects, you can browse the contents of each database to search for what you’re looking for, and then copy one or more projects from one database to another if you need to rearrange how they’re organized.
To view the contents of a database:
1 Click the button at the upper-left hand corner of the Projects window to open the Databases sidebar.
2 Click to select a database in the sidebar, and an orange highlight will appear.

If you had a project already open, you’ll be asked if you want to save it before closing, because all open projects must be closed prior to viewing the contents of another database. Then, the projects corresponding to that user within the selected database appear in the Project Manager window.

To import a project from another database using the Databases sidebar:
1 Click the button at the upper-left hand corner of the Projects window to open the Databases sidebar.
2 Click to select a database in the sidebar, and if necessary use the drop-down menu at the right of the database listing to choose a specific user. The projects corresponding to that user within the selected database appear in the Project Manager window.
3 Select a project you want to import, and press Command-C to copy it.
4 Click to select the current database again (the database you want to work within).
5 Press Command-V to paste the project you copied. A copy appears in the current database.

NOTE: For more detail on shared database setup and operation, see Chapter 192, “Managing Databases and Project Servers.”

To import Project Settings from another project using the Databases sidebar:
1 Click the button at the upper-left hand corner of the Projects window to open the Databases sidebar.
2 Select a project you want to import Project Settings to so that it’s highlighted.
3 If necessary, click to select another database in the sidebar, and optionally use the drop-down menu at the right of the database listing to choose a specific user. The projects corresponding to that user within the selected database appear in the Project Manager window.
4 Right-click any project and choose “Load Project Settings to Current Project.” That project’s settings will be copied to the project you selected in step 2.

Managing Databases in the Databases Sidebar
Controls within the Databases sidebar make it easy to create new databases (via the button at the bottom), upgrade databases that have been flagged (via circular badges), import and export databases (via buttons at the top), and reveal additional information about each database (via buttons at the top of this sidebar).
The five controls at the top of the Databases sidebar have the following functions:

- **Backup Database:** You can back up databases just like any other file. This provides added protection should your system drive fail, but a database backup can also be used to move multiple projects between systems (particularly if you’re using PostgreSQL). Clicking this button exports the currently selected database, with all enclosed projects, to a self contained .resolve.backup file.

- **Import Database:** Imports .resolve.backup files to restore a backed up database.

- **Connect Database:** Allows connection to an existing database, either on a local disk or on a PostgreSQL server.

- **Sort Order drop-down menu:** This menu lets you choose how to sort the various Disk and PostgreSQL databases displayed in the sidebar. You can sort by Database Name, Schema (by date), Status, or Location in Ascending or Descending order.

- **Display Database Info toggle:** Turning this control on shows additional information underneath each database in the sidebar. What information depends on the type of database. Disk databases display their status (compatible/incompatible) and location (directory path). PostgreSQL databases display their schema (a date), their status (compatible/incompatible), their IP location, and any remarks that were appended when that database was updated.

- **Show Search Field:** Displays a search field and search criteria drop-down that lets you search for databases in the side bar by Name, Schema, Status, or Location.

### Disk Vs. PostgreSQL Databases

When you first install DaVinci Resolve on a workstation it’s never been installed on before, you are set up to use a Disk database by default, which saves user-accessible project files to a disk location of your choosing.

In many respects, Disk databases are simple to use. They’re easier to back up, as they’re located in an easily found directory, and in fact you can create Disk databases in custom locations, if you like. Disk databases avoid the need to know or care which version of PostgreSQL is installed on your machine, as PostgreSQL isn’t used. Furthermore, projects in Disk databases don’t need to go through an explicit “upgrade” process when you upgrade significant versions of DaVinci Resolve, as the project is automatically upgraded when you open it (the upgraded project can be saved independently from the original project using the Save As command if you want to leave the un-upgraded version intact).

However, many users prefer to use PostgreSQL database project management, particularly for situations where you want to use a shared database server so multiple rooms can access the same project files, and for collaborative workflow, where multiple editors, colorists, and audio professionals can work within the same project file.

Fortunately, it’s easy to create and use either type of project database for maximum flexibility in organizing your projects. Then, using the Databases sidebar, it’s easy to go back and forth between the two types of database management simply by creating the type of database you need and then switching over to it using the sidebar.

### Creating New Disk and PostgreSQL Databases

You can use Disk databases and PostgreSQL databases side by side for switching to the use of one or the other, depending on your needs.

**To create a new Disk database:**

1. Click the button at the upper-left hand corner of the Projects window to open the Databases sidebar.

2. Click the New Database button at the bottom of the sidebar.
3 Leave Type set to Disk. The New Database window should look like the following screenshot:

![Creating a Disk database](image)

4 In the remaining fields, do the following:
   a Type a name for the new database into the Name field
   b Click within the Location field and use the Filesystem navigation dialog to choose where to put the directory that will contain all of the DaVinci Resolve project directories

5 Click Create, and the new disk database will appear in the Disk database section of the Databases sidebar.

To create a new PostgreSQL database:
1 Click the button at the upper-left hand corner of the Projects window to open the Databases sidebar.
2 Click the New Database button at the bottom of the sidebar.
3 Change Type to PostgreSQL, and different options will appear at the bottom of the New Database dialog. The New Database window should look like the following screenshot:

![Creating a PostgreSQL database](image)

4 Type a name for the new database into the Name field. Because all projects in a PostgreSQL database are saved internally within the PostgreSQL database, no other changes are necessary.

5 Click Create, and the new disk database will appear in the PostgreSQL database section of the Databases sidebar.
Backing Up and Restoring Databases

You can also back up databases by exporting them, and then reimport them later.

To backup/export a database:

1. Click the button at the upper-left hand corner of the Projects window to open the Databases sidebar.
2. Select the database you want to back up.
3. Click the Backup button at the top of the Databases sidebar.

4. Choose a location to which to save the backup in the Backup Database dialog, and click Save.

To import a database:

1. Click the button at the upper-left hand corner of the Projects window to open the Databases sidebar.
2. Click the Import Database button at the top of the Databases sidebar.

3. Find the database you need to import using the file import dialog, and click Open.

Upgrading Databases

Databases display an upgrade badge (circular arrows) only when you’ve installed a new version of DaVinci Resolve and you have databases that were created in older versions of DaVinci Resolve that need upgrading.

A badge at the right of a database indicates that database needs to be upgraded.

It’s generally a good idea to back up a database prior to upgrading it, in case something goes wrong.

In general, upgrading from a whole version release to the next whole version release of DaVinci Resolve usually requires an upgrade, while upgrading to a dot release of the same version may or may not. If the currently used database requires an update, you’ll be told on application startup.

To upgrade a database from an old version of DaVinci Resolve:

– Right-click a database that needs updating, and choose Upgrade from the contextual menu.

A dialog appears to confirm if you really want to upgrade that database. Click Upgrade to proceed.
Disconnecting and Deleting Databases
You cannot actually delete databases in DaVinci Resolve; you can only disconnect them so they don’t appear in the Database list. However, disconnected databases can still be reconnected if you remember their name. The only way to completely delete a database entry in PostgreSQL is to do so from the command line, or to use the PGAdmin III application that accompanies the PostgreSQL installation that’s part of the DaVinci Resolve installation process.

To disconnect a database you no longer need:
– Right-click a database that is not currently selected, and choose Disconnect from the contextual menu. A dialog appears to confirm if you really want to disconnect that database. Click Disconnect to proceed.

Locating Disk Database Directories in Your File System
Because Disk databases have a link to a specific directory in your file system, there’s a way of locating that directory.

To locate a database on your system:
– Right-click any Disk database, and choose “Reveal in Finder.” A file system window opens up showing you the location of that Disk database, inside which are all of its projects.

Optimizing Databases
Only available for PostgreSQL databases. Sometimes, databases in DaVinci Resolve can become so large that the size affects performance. In these cases you may need to optimize them to improve access speed by “vacuuming” the database of unnecessary spaces and reindexing it. Using the Optimize command can also be a valuable troubleshooting step in certain cases where you’re having problems opening, importing, or otherwise using projects saved within PostgreSQL databases.

To optimize a database:
– Right-click a database, and choose Optimize from the contextual menu. A dialog appears to confirm if you really want to optimize that database. Click Optimize to proceed.

Legacy User Organization in the Databases Sidebar
DaVinci Resolve was originally designed as a multi-user application for use in commercial suites. While DaVinci Resolve is still very much used in that capacity in high-end facilities around the world, starting in DaVinci Resolve 14 the interface that was previously used to create and manage multiple users on a single workstation has been eliminated in favor of a simpler method of managing multiple databases right in the Project Manager, via the Databases sidebar. However, if you’ve upgraded databases that were previously organized using multiple users, the Database > User > Project structure of older databases is maintained via a drop-down menu to the right of that database’s name in the Databases sidebar.

Legacy users in a database
Saving Projects

Once you've created and opened a project, you want to make sure that you regularly save your work.

Methods of saving projects:
- Choose File > Save Project (Command-S).
- Push the SAVE button on the DaVinci control panel.
- To save the current state of your project as a copy with a new name, choose File > Save Project As (Command-Shift-S), then enter a name into the Save Current Project window and click Save.

To revert to the last saved state of a project:
- If you don’t want to save, but you want to revert to last saved state of the project, choose File > Revert to Last Save.

As you work on your project, the word “Edited” appears to the right of the project name at the top of the DaVinci Resolve UI to let you know that you have unsaved changes. If you don’t save in over 15 minutes, the word “Edited” turns yellow, and if you still don’t save in over 30 minutes, it turns red to let you know that you probably should save. If you move the pointer over the word “Edited,” a tooltip appears letting you know when the last save was performed.

DaVinci Resolve also has two auto save mechanisms that you can enable in the Save Settings group of controls, called Live Save and Project Backups.

Live Save

Enabling Live Save sets DaVinci Resolve to incrementally save changes as you make changes to your project, with no user intervention required. Disabling Live Save puts DaVinci Resolve back into a state where you have to manually save by pressing Command-S (this can be useful when doing demos when you don’t want to save your changes to a project). Using Live Save is turned on by default and highly recommended to prevent the loss of work in the event you have a problem. It even works for previously unsaved projects that you’ve forgotten to save if anything goes wrong.
NOTE: When you use Collaborative Workflow to enable multiple artists to work together in
the same project, Live Save is automatically turned on and cannot be disabled.

Project Backups

Turning on the Project Backups checkbox in the Project Save and Load panel of the User Preferences enables DaVinci Resolve to save multiple backup project files at periodic intervals, using a method that’s analogous to a GFS (grandfather father son) backup scheme. This can be done regardless of whether or not Live Save is turned on. Each project backup that’s saved is a complete project file, excluding stills and LUTs, which are omitted in order to save storage space.

Once you’ve enabled Project Backups for a long enough time, whatever saved project backups have been created are retrievable in the Project Manager via the contextual menu that appears when you right-click a project, by choosing Project Backups to open the backups list dialog. The backups list dialog shows you all backups that are available for a particular project, and has controls for sorting the list via different columns, deleting some or all of the backups in the list, and loading backups that you want to retrieve. Opening a project backup does not overwrite the original project; project backups are always opened as independent projects.

To enable Project Backups:

1. Choose DaVinci Resolve > Preferences, and open the Project Save and Load panel.
2. Turn on the Project Backups checkbox.
3. Choose the settings that determine how many Project Backups will be maintained. Project Backups are saved on a first in, first out basis. Three fields let you specify how often to save new backups and how many backups to maintain, while the fourth lets you choose where the backups will be saved.
   - **Perform backups every X minutes:** The first field specifies how often to save a new backup within the last hour you’ve worked. By default, a new backup is saved every 10 minutes, resulting in six backups within the last hour. Once an hour of working has passed, an hourly backup is saved and the per-minute backups begin to be discarded on a “first in, first out” basis. By default, this means that you’ll only ever have six backups at a time that represent the last hour’s worth of work.
   - **Hourly backups for the past X hours:** The second field specifies how many hourly backups you want to save. By default, 8 hourly backups will be saved for the current day you’re working, which assumes you’re working an eight hour day (wouldn’t that be nice). Past that number, hourly backups will begin to be discarded on a “first in, first out” basis.
   - **Daily backups for the past X days:** The third field specifies for how many days you want to save backups. The very last project backup saved on any given day is preserved as the daily backup for that day, and by default daily backups are only saved for five days (these are not necessarily consecutive if you take some days off from editing for part of the week). Past that number, daily backups will begin to be discarded on a “first in, first out” basis. If you’re working on a project over a longer stretch of time, you can always raise this number.
   - **Project backup location:** Click the Browse button to choose a location for these project backups to be saved. By default they’re saved to a “ProjectBackup” directory on your scratch disk, although you could change this to a volume that better fits into your data backup methodology.
4. Click Save to confirm your change, and then close the Preferences window.

NOTE: When using this feature, the very first backup that’s saved for a given day may be a bit slow, but all subsequent backups should be unnoticeable.
Once one or more Project Backups have been saved, you can access them in the Project Browser.

**To open a Project Backup that’s been saved:**

1. Open the Project Manager.
2. Right-click a project, and choose Project Backups from the contextual menu.

3. Select a backup that you want to restore from the Auto Backups list. If you don’t see the particular backup you want, you can click the Refresh button to update the list, or you can try sorting by one of the columns (Auto Backup, Date Modified, Width, Height) to better navigate the list.

4. Once you’ve selected the backup you want to restore, you can click Load to open that backup as a new project. If the project it was saved from is already open, it won’t be overwritten.
Project Notes

Each DaVinci Resolve project now provides access to Project Notes, which is a simple “scratch pad” for keeping track of text notes associated with each project. These notes can be accessed using the File > Project Notes command, and there’s also a Project Notes command in the contextual menu for project icons in the Project Manager, which makes these notes accessible to everyone who’s connected to that database.

Dynamic Project Switching

Dynamic Project Switching is an option in the Project Manager contextual menu that lets you open multiple projects into RAM simultaneously, so you can quickly switch between projects when you want to copy and paste clips, timelines, and node settings back and forth. If you plan on opening many projects, or even just a few very large projects, you should be sure your workstation has an appropriate amount of RAM installed or you could experience a slowdown in performance.

Methods of using Dynamic Project Switching:

– To enable Dynamic Project Switching: Open the Project Manager, right-click anywhere within the Project Manager and choose Dynamic Project Switching so that it’s checked. Dynamic Project Switching will remain enabled until you turn it off.

– To open multiple projects in RAM: Open any project, then reopen the Project Manager and open any other project. All projects you open are kept available in RAM.

– To switch among open projects: Choose File > Switch Project and select the project you want to switch to from the submenu. You can also choose other projects that have been opened into RAM from the drop-down menu that appears to the right of the project name at the top center of the DaVinci Resolve user interface.

– To close a specific project: Choose File > Close Project and select the project you want to close from the submenu. You may be prompted to save, after which the project closes.

– To close all other open projects: Open the Project Manager. All open projects appear with a check mark in the upper right-hand corner; the currently open project has an orange corner mark, while other projects open in memory have a gray corner mark. Right-click anywhere within the Project Manager, and choose Close Projects in Memory to close all projects other than the current one.

Using dynamic project switching, you can do the following:

– Copy and paste clips from the Media Pool of one project into another.

– Copy and paste timelines from the Media Pool of one project into another. When you paste a timeline from another project, all of the clips used in that timeline will be pasted to the same location as well.

– Copy and paste clips from a timeline in one project to a timeline in another.

– Copy a node’s settings from one project and paste them to a node in another project.

You can also copy and paste clips, timelines, and node settings from one project to another without using dynamic project switching, but using switching makes this process faster.
Archiving and Restoring Projects

DaVinci Resolve has a convenient feature for quickly archiving every single media file used by a project, including subtitle files, along with the project itself, to a single location. This can be done to hand a project off to another DaVinci Resolve user, or to bundle a project and its media up for either short- or long-term archiving using the backup methodology of your choice. The process is simple.

To Archive a project:

1. Open the Project Manager.
2. Locate and right-click the project you want to archive, and choose Archive.

3. When the Archive Project window appears, choose a location to save the archive. Make sure you choose a volume that’s large enough to accommodate the size of all the media from the project you’re archiving, and click Save.

4. When the Archive dialog appears, verify the location the archive will be saved to, and choose which optional media you want to save within the archive. You can optionally save Optimized media and/or Render Cache media associated with a project.

5. Click Ok, and a dialog with a progress bar will show you how long the archive operation will take to finish. If any errors come up, resulting from missing or offline media, they’ll be presented at the end of the process.
The resulting archive that is written is a directory with the .dra file extension. Inside this folder are a series of subdirectories containing all of the media that’s used by the archived project. Each directory of media files used is saved within a directory path that mirrors the exact path it came from, so you have a reference for where each clip came from originally.

**To restore an Archived project:**

1. Copy the .dra archive directory you want to restore to the volume where you want those media files to be. Restoring doesn’t move this directory, it only adds the project file within to the Project Manager, so you should make sure the .dra archive directory is located on a storage volume with suitable performance for you to work.

2. Open the Project Manager, right-click anywhere, and choose Restore from the contextual menu.

3. Choose the .dra archive directory you just copied, and click Open.

4. At the prompt, enter a unique project name for the restored project, and click OK. The project is restored to the Project Manager, and remains linked to the media located inside the .dra archive.

If, after restoring an archive, you want to move its media to another location, you can use Media Management to do a move operation for all clips in that project. For more information on Media Management, See Chapter 46, “Media Management.”
Chapter 4

System and User Preferences

This chapter covers the settings used for customizing the DaVinci Resolve environment. System Preferences govern setup options that control the hardware and software environment, while User Preferences control various user controls within the software.

Contents

DaVinci Resolve Preferences 86
Adjusting Preferences 87
Individual Preferences and Settings Based on Login 87
Resetting Preferences 87
System 87
Memory and GPU 87
Media Storage 88
Decode Options 90
Video & Audio I/O 90
Video Plugins 92
Audio Plug-ins 93
Control Panels 93
General 94
Internet Accounts 95
Advanced 96
User 96
Saving User Preference Presets 96
UI Settings 97
Project Save and Load 98
Editing 100
DaVinci Resolve Preferences

The DaVinci Resolve Preferences window contains workstation-specific settings for customizing how DaVinci Resolve works, divided into System and User panes, selectable via buttons at the top of this window.

To open the Project Settings window, do one of the following:

– Choose DaVinci Resolve > Preferences.
– Press Command-Comma.

**TIP:** You can open the preferences while the Project Manager is open when you first run DaVinci Resolve by pressing Command-Comma.

System Settings of the Preferences window
Adjusting Preferences

The System and User panes are each divided into a series of panels which can be selected from a sidebar at the left. Each panel contains a collection of related settings that affects some category of DaVinci Resolve functionality.

To alter any preference setting:
1. Click on the name of any group of settings in the sidebar at the left to open that panel.
2. Change whatever settings you need to change.
3. Click Save to apply the changes you’ve made and close the Preferences window.

If you’ve updated certain System Preferences, you’ll be prompted to restart DaVinci Resolve, but if you’ve updated the User Preferences, this will probably be unnecessary.

Individual Preferences and Settings Based on Login

As of DaVinci Resolve 16, there are individual preferences and settings for each login account on a given computer. This means that multiple artists can each have their own operating system login, and DaVinci Resolve will maintain separate workspace layouts and preference states for each artist, depending on who’s logged in.

Resetting Preferences

Resetting all preferences to their defaults is simple. Click the Option menu at the upper right corner of the Preferences window and choose Reset System Preferences.

System

The System pane of the Preferences window consists of a series of panels that configure the computer and other hardware that comprises your DaVinci Resolve workstation.

Memory and GPU

The top section of this panel provides Memory Configuration options, while the bottom section of this panel provides controls over how GPU processing is handled.

Memory Configuration

This section has the following preference settings handling memory usage.

– **System Memory**: The total available RAM on your workstation is listed here.

– **Limit Resolve Memory Usage to**: This preference limits the total amount of system memory that Resolve uses, keeping memory available for other applications. The maximum and default setting for this preference is 75 percent of your system’s RAM.

– **Limit Fusion Memory Cache to**: Lets you limit how much RAM the playback cache on the Fusion page is allowed to use. Depending on the length of clips you’re working on in the Fusion page, the playback cache can occupy a considerable amount of available memory. The amount you allocate here is taken from the total amount of memory allocated by the “Limit Resolve Memory Usage to” setting.
GPU Configuration

This section lets you choose how GPU processing should be handled.

Options for configuring the GPUs on your workstation

- **GPU processing mode**: Lets you set DaVinci Resolve to use the OpenCL, CUDA, or Metal GPU computing APIs for doing effects processing. Which is best depends on the GPUs that are installed in your computer. Most users can leave this set to Auto to let DaVinci Resolve choose what’s appropriate. Otherwise, here are specific recommendations. If you have a macOS system, you should use Metal. Linux and Windows users with AMD GPUs should use OpenCL. Linux and Windows users with Nvidia GPUs should use CUDA, but make sure you have the correct drivers for your system, and that you have the latest update to CUDA installed. Additionally, when you manually choose an option from this drop-down menu, the GPU selection mode drop-down also appears.

- **GPU selection mode**: Lets you choose between Auto, which lets DaVinci Resolve choose which of the available GPUs on your computer to use for processing, and Manual, which lets you choose which GPUs to enable or disable for processing from a list that appears below. This can be useful in instances where you have multiple GPUs installed on a machine and you want to choose only the most powerful GPUs for processing. This can also be useful in instances where an external eGPU is connected to a laptop or all-in-one with a weaker GPU, so you can choose the more powerful eGPU for processing.

- **Use Display GPU For Compute**: By default, a single GPU system uses the same GPU for the DaVinci user interface and also for image processing. As greater processing speeds are achievable with two or more GPUs, if two GPUs are installed for image processing, this checkbox enables the shared use of the display GPU instead of dedicating it to just the DaVinci user interface. Users of the non-studio version of DaVinci Resolve are restricted to the use of a single GPU, unless DaVinci Resolve is installed on a 2013 or later Mac Pro, in which case both installed GPUs will be used.

- **GPU selection list**: This list only appears when GPU processing mode is set to either OpenCL, CUDA, or Metal, and when GPU selection mode is set to Manual. A list of every GPU installed in your computer appears, and you can use checkboxes to the left of each GPU to enable or disable specific GPUs from being used for processing.

- **Optimized Viewer Updates**: This only appears on multi-GPU macOS and Windows systems or on single- and multi-GPU Linux systems; enables faster viewer update performance.

Media Storage

This panel lets you define the scratch disk and other media storage locations used by DaVinci Resolve, as well as the default cache directories locations to be used when creating new projects.

- **Media Storage Locations**: This list lets you define the scratch disk of the system. The first volume in this list is where Gallery stills and cache files are stored, so you want to make sure that you choose the fastest storage volume to which you have access.
– **Mapped Mount:** This column allows you to specify translatable media path mapping between Mac, Linux, and Windows file system conventions.

– **Direct I/O:** This Linux-only option allows DaVinci Resolve to write directly to the drive using the kernel buffers, bypassing the normal storage cache in RAM. This allows access to the full performance of the drive.

– **Automatically display attached local and network storage locations:** This checkbox lets DaVinci Resolve access media on all temporarily and permanently mounted volumes, including SATA and eSATA, SAS, USB, FireWire, Thunderbolt, Gigabit Ethernet (GbE or GigE), Fibre Channel, and otherwise connected hard drives, without having to add them to this list. This is on by default.

If you’re using the Apple App store version of DaVinci Resolve, turning on “Automatically display attached local and network storage locations” automatically prompts you via a dialog to add “Macintosh HD” as a storage location. Clicking Add Location prompts you to select the Macintosh HD volume with another dialog, and clicking Open then adds that volume to the Media Storage Volumes list. After you click Save to close the Preference windows, Resolve should now automatically mount any volumes attached to your computer in the Media Storage browser of the Media page. Don’t do this until after you’ve added a fast storage volume to the Media Storage Locations list, because you don’t want Macintosh HD as the first volume in this list – the very first volume in this list should always be reserved for your fast scratch volume.

### Adding Storage Locations Manually

Some versions of DaVinci Resolve do not allow automatic display of attached volumes. In this case, you can right-click anywhere in the background of the Media Storage panel’s volumes list on the Media page and choose “Add New Location” to open a dialog you can use to choose a volume you want to add.

![Manually adding a volume to the Media Storage panel’s volumes list](image)

### Using Path Mapping to Access Volumes From Other Operating Systems

Shared media path mapping support for Mac, Linux and Windows makes it easier for multi-system shops to share Resolve projects among different platforms that use different file path conventions.

**To add a mapped mount string:**

1. Open the Media Storage panel of the Resolve Preferences window.
2. Add the volume you want to map to the Scratch Disks list.
3. Double-click the Mapped Mount column of the drive you added to edit it.
4. Enter the alternate file path you want that volume to have. For example, if you’re on a Windows workstation and you want to access a Linux volume, type the Linux file path into the Mapped Mount column.

**NOTE:** If the volume you’ve selected to use for the cache becomes unavailable, DaVinci Resolve will warn you with a dialog.
Decode Options
This panel contains all options available for using the GPU to accelerate the decoding and debayering of various formats.

- **Use GPU for Blackmagic RAW decode**: Lets you use your GPU to accelerate the decoding of Blackmagic RAW (BRAW) media.
- **Decode H.264/HEVC using hardware acceleration**: Allows the use of hardware acceleration for H.264 or HEVC playback, if available on the computer you’re using.
- **Use easyDCP decoder**: Since DaVinci Resolve has its own DCP encoder and decoder built in, this checkbox lets you switch over to using easyDCP to do DCP decoding, if you have a license installed on your workstation.
- **Automatically refresh growing files in the media pool**: If you’re using a third-party application that records live to a growing video file, you can now begin to edit that file while it’s still recording. Simply import the growing file into the Media Pool, and when this box is checked, DaVinci Resolve will continuously refresh to determine if the file has changed, and automatically update its attributes in the Media Pool.
- **Use GPU for RED Debayer**: Lets you use your GPU to accelerate debayering of R3D media. The latest RED API enables accelerated 8K debayering using either Metal or Cuda.

There are three options:
- None
- Debayer
- Decompression and Debayer

- **Use Red Rocket if available**: (Only appears if a RED ROCKET-X or RED ROCKET is installed.) This checkbox lets you disable Red Rocket support if you need to force DaVinci Resolve to use standard RED software CPU debayering to accommodate your specific workflow or when troubleshooting. If you are required to debayer R3D media using your CPU, turn this checkbox off. Additional options appear letting you choose decompression and debayer settings.

Video & Audio I/O
The preferences in this panel let you choose video and audio interfaces on your workstation.

**Video & Audio I/O**
This section lets you choose which Blackmagic Design video interfaces you want to use for monitoring, capture, playback, and Resolve Live, assuming you have any connected to your workstation. If you have more than one Blackmagic Design video device connected to your computer, you can independently configure them for playback and capture. If no interfaces are connected, no options will be available.

- **For playback use**: If you have a compatible video output card, you should choose from the card options that appear here. Leaving this set to “None” disables external video output. Disabling video output can improve real time performance when external monitoring and output is not a priority. You can also choose “None” when you’re using DaVinci Resolve with another application open at the same time that’s using your workstation’s video output interface. When you’ve quit the other application, you can reselect the video output interface for use by DaVinci Resolve. Any changes to this setting require a restart of the program.

- **For capture use**: If you have a compatible video capture card for video input, you should choose from the card options that appear here. This setting also sets the selected input device for use in Resolve Live, allowing you to monitor and color correct a live video signal. Any changes to this setting require a restart of the program.
– **Release video I/O hardware when not in focus:** When turned on, DaVinci Resolve releases control of the video output device whenever you switch to another application.

– **Enable Fairlight Audio Accelerator:** Turning this checkbox on enables an installed Fairlight Audio Accelerator PCI card to be used by DaVinci Resolve for accelerated audio processing and for all audio I/O monitoring and recording.

– **Audio Interface:** Turning Enable Fairlight Audio Accelerator on exposes an additional menu that lets you choose which audio interface to use for audio I/O; the choices are MADI (if you’re going to use a third-party MADI interface) or Fairlight Audio Interface and MADI (if you also want to use the Fairlight Audio Interface).

**Speaker Setup**

This section lets you define different sets of speakers with which to monitor audio playback. To access more than the default stereo system output that most workstations default to, you must use whatever software is available for your operating system to choose the desired audio hardware you want to use, and define how many audio outputs are required for the type of monitoring you want to do (stereo, surround, and so on). For example, on macOS you’ll use the Audio Midi Setup utility to choose output hardware and select a speaker configuration to be made available on your system. For more information, see the DaVinci Resolve Configuration Guide, available on the web from the Blackmagic Design support page at [https://www.blackmagicdesign.com/support/family/davinci-resolve-and-fusion](https://www.blackmagicdesign.com/support/family/davinci-resolve-and-fusion).

– **Speaker configuration:** Lets you choose between two settings. “Use System Setting,” which sets DaVinci Resolve to output audio via your workstation’s built-in audio output, even if a compatible video I/O interface is enabled for capture and playback or for Resolve Live. “Manual” exposes additional controls with which you can define your own speaker setup.

– **Monitor Set:** For each Monitor Circuit, you can define multiple sets of monitoring speakers. The default two are MAIN (your primary monitoring speakers) and NEAR (usually a secondary set of inferior speakers for checking the mix on cheaper consumer gear). However, options for Set 2–15 lets you define up to 15 different combinations of monitoring speakers that you can switch among for checking or creating different mixes. Click the Rename button to rename any of the more generically labeled monitor sets to something more memorable.

– **Device:** This setting lets you choose which, of the audio I/O interfaces connected to your workstation, you want to use for that particular monitor set. Different monitor sets can use different I/O hardware, making it possible to listen to different speakers via different audio I/O boxes. Every compatible audio I/O device connected to your workstation should appear in the Device drop-down menu.

![Assigning different audio I/O devices to different speaker configurations](image)

– **Monitor Set Format:** This menu lets you define the format of the currently selected Monitor Set. Options include Mono, Stereo, LCR (left/center/right), LCRS (left/center/right/sub), LCRSS, 5.1/Film, 6.1, and 7.1/Film.
Monitor output list: Depending on the Monitor Set Format you choose, each stem of the mix will have an entry in this list with controls that let you map which output goes to that particular speaker, as well as what gain adjustment (if any) you want to make. The number of outputs available in this list reflects the number of speakers made available by your operating system, so if you don’t see the required number of outputs that you want to map to different stems, you should configure your system audio using the procedures available in the DaVinci Resolve Configuration Guide.

About Audio Monitoring and Audio Input

The audio processing throughout DaVinci Resolve, including on the Fairlight page and audio processing using Fairlight FX plug-ins, is equally compatible with all platforms that DaVinci Resolve runs on, including macOS, Windows, and Linux. In particular, DaVinci Resolve supports audio monitoring and audio input using (i) the audio of a supported Blackmagic Design I/O device such as an UltraStudio or Decklink, (ii) your macOS, Windows, or Linux workstation’s on-board audio, (iii) any Core Audio compatible, Windows compatible, or Advanced Linux Sound Architecture (ALSA)-supported third party audio interface.

Alternately, you can monitor audio with the optional Fairlight Audio Accelerator, which is a PCI card that’s designed to handle even more channels of audio I/O monitoring and recording, and that’s also capable of accelerating audio processing operations to provide better performance for audio operations.

Dolby Atmos Configuration Controls

The Video and Audio I/O panel of the DaVinci Resolve System Preferences lets you enable and configure the use of a Dolby RMU for doing Dolby Atmos mixing. You can enter the IP address of the RMU, and choose the base audio output.

Video Plugins

You can selectively enable and disable specific Open FX plug-ins on startup. You can use this function to streamline and organize the Open FX list to just the plug-ins you commonly use, or to exclude a problematic plug-in that causes instability in the system. Additionally, DaVinci Resolve automatically checks the last plug-in loading result on startup, and skips any plug-ins that previously caused a crash or hang.

Individual Open FX plug-ins can be manually enabled and disabled in the Video Plugins panel by checking or unchecking the boxes corresponding to the plug-ins.

The Video Plugins panel allows you to enable or disable specific Open FX plug-ins at startup.
Audio Plug-ins

Three sections of parameters let you manage VST Effects, enabled plug-ins, and external audio processes.

- **VST Effects**: A list at top lets you manually add and remove VST plug-in effects directories, if necessary. VST effects aren’t installed in a standard location, so it may sometimes be necessary to add a newly installed directory of VST plug-ins that you’ve just installed on your system.

- **Available Plug-ins**: Once you’ve added one or more VST directories to the list, a second list underneath shows all audio plug-ins that are available within these directories. Each plug-in on the list has a checkbox that shows whether or not it’s currently enabled. Any VST plug-ins that cause DaVinci Resolve to crash while loading them during startup will be automatically disabled. You can use this list to see which plug-ins have been disabled, for troubleshooting purposes, and to reenable such “blacklisted” plug-ins by turning their checkboxes back on.

- **Setup External Audio Processes**: While working in the Fairlight page, you have the ability to process an audio file using a third-party application, if necessary, in the event you need to use another application’s capabilities to create an effect or solve an issue that can’t be accomplished in the Fairlight page itself. To do this, you must first add one or more applications to the External Audio Process list in the Audio Plug-ins panel of the System Preferences.

**To add an External Audio Process:**

1. Click the Add button.
2. Double-click the text in the Name column and change the name to that of the application or process you’re going to link to.
3. Click once in the Path column, and then use the file dialog to locate and select the application or script you want to use as the external audio process.
4. Open the drop-down menu in the Type column, and choose how you want the selected audio process to work: Reveal (open the application), Command Line (use from Terminal), or Clipboard (copy the audio clip file path to the clipboard to paste into the open command of an application or utility).
5. When you’re done, click Save, and restart DaVinci Resolve if you’re prompted to.

Control Panels

Two sections let you specify which Color Grading Panel and Audio Console is connected to your workstation.

- **Color Grading Panel**: A menu lets you choose which color grading panel you have connected to your workstation. Some panels expose additional controls.
  
  If you have a DaVinci Resolve Mini or Micro Panel, leave this setting set to None and these panels will be auto-detected by Resolve when you plug them in.

  If you have a control panel that connects via USB, choose your panel from the list.

  If you have a DaVinci Resolve Mini Panel connected over Ethernet, choose “DaVinci Resolve Mini Panel (Ethernet)” and then choose your panel from the drop-down that appears.

  If you’re using a JLCooper Eclipse, choose “JLCooper Eclipse CX” and then enter the IP and Port number into the fields that appear.
– **Use MIDI Audio Console:** A checkbox lets you enable the use of a third-party audio console that’s connected to your workstation. Turning this on exposes three additional menus.

– **MIDI Protocol:** Lets you choose either the HUI or MCU protocol, whichever is compatible with the audio console you want to use.

– **MIDI Input:** Lets you choose the MIDI input used to connect your console.

– **MIDI Output:** Lets you choose the MIDI output used to connect your console.

---

**General**

This panel provides various options for scripting, audio processing, monitoring, and sending problem reports.

– **External Scripting Using:** (Resolve Studio only) Options include None, Local, and Network. When set to None, only scripting in the Console window is allowed. When set to Local, external scripts and applications on the same computer can control DaVinci Resolve. When set to Network, external scripts and applications from other computers on the network (or via the internet) can control DaVinci Resolve.

– **Audio Processing Block Size:** Lets you increase the sample block size to add processing headroom to the system, at the expense of adding latency to audio playback. The default value is Auto, which automatically chooses a suitable setting for the audio I/O device you’re using.

For those who have specific needs and are interested in setting this manually, here are some examples of use. In a first example, when a system is under a heavy load (there are many plug-ins being used on many tracks), then increasing the block size to add processing headroom will result in a longer delay every time your audio hardware requests samples to feed the speakers. If you’re only mixing, the resultant latency may not be a problem, so this gives you the option to add headroom so your system can run a few more plug-ins or tracks.

On the other hand, this increased delay in the processed audio running through the mixer is a much bigger problem if you’re recording an artist in an ADR session, where they need to hear themselves in the headphones, or when you’re recording foley or voice over and there’s an increased delay between what you see and what you’re recording, so in this case sticking with the default value (or smaller) will sacrifice processing headroom for diminished latency.

**TIP:** A common strategy when you need to force more cooperation from a particular combination of workstation and audio interface is to reduce Audio Processing Block Size when you’re about to do a recording session, when track and plug-in use is lower. Later, when you start mixing in earnest and adding plug-ins, you can increase Audio Processing Block Size to give you better performance once you’re finished recording.

– **Use 10-bit precision in viewers if available:** This checkbox only appears on Mac OS X 10.11 (El Capitan) and higher installations of DaVinci Resolve. Turning this checkbox on lets DaVinci Resolve display 10-bit images in the Viewer.

– **Use Mac Display Color Profile for viewers:** If you’re using DaVinci Resolve on macOS, this checkbox enables all viewers in DaVinci Resolve to use whatever display profile is selected in the Displays panel of the System Preferences. This lets DaVinci Resolve use ColorSync on macOS so your Viewer image should better match your output display.

– **Automatically Tag Rec.709 Scene Clips as Rec.709-A:** Turn this checkbox on to automatically tag any Rec. 709 QuickTime files for Rec. 709-A playback. This setting is useful if your final QuickTime video does not match what you see in the Resolve viewers (gamma shift), and you wish to export for the web rather than broadcast.
– **Automatically Scan other databases for remote rendering jobs**: Turn this checkbox on to scan all connected databases, rather than just the current database for possible remote rendering jobs.

– **Automatically Check for Updates**: Turn this checkbox on to make it easier to ensure you’re using the latest version of DaVinci Resolve. You can also choose DaVinci Resolve > Check For Updates to notify you of new versions and download them when available.

– **Automatically opt-in for new beta program notifications**: Lets you know when public beta versions of DaVinci Resolve become available, in case you’re interested in living on the edge.

– **Send report when application quits unexpectedly**: When this checkbox is turned on, this setting enables DaVinci Resolve to automatically prepare a problem report whenever DaVinci Resolve unexpectedly quits. You get to fill out some information (please be as specific as you can about what you were doing when DaVinci Resolve had its issue) and click a button to send the report.

– **Automatically send problem reports**: When this checkbox is turned on, problem reports are automatically sent, with no user intervention. You have the option of adding your name and email address to be automatically included, but this information is optional.

### Internet Accounts

DaVinci Resolve 16 introduced integration with YouTube, Vimeo, Twitter, and Frame.io that allows you to render and upload directly to each service. This panel provides buttons that let you sign into your YouTube, Vimeo, and Frame.io accounts, as well as specify a local cache location for media being synced with Frame.io.

For each service you sign into, a floating window presents the interface in which you’ll need to enter your login name and password to enable integration, followed by whatever two-factor identification and other required steps are necessary. Once entered, DaVinci Resolve will sign in to each of these services automatically when DaVinci Resolve opens.

![Internet Accounts panel of the System tab of the DaVinci Resolve Preferences window](image)

**NOTE**: For Frame.io, the local cache location is used to store clips you import into a DaVinci Resolve project from the Frame.io volume in the Media Storage panel of the Media page.
Advanced
This tab is used for special Resolve configurations and SAN parameters that are applicable to older file systems.

User
This panel lets you choose user preferences, specific to your workstation, that govern such things as UI behaviors and appearance, auto save settings, editing and color defaults, control panel action, and keyboard shortcut mappings.

TIP: Many of the settings in the User panel used to be found in the Project Settings window prior to version 14, but they were moved here to accommodate collaborative workflows with each user having their own independent general, editing, and color settings, as well as their own keyboard shortcuts.

Saving User Preference Presets
It’s possible to save multiple presets for instant recall of different User Preference settings, using the Option menu in the UI Settings window.

Methods of managing User Preference presets:
– **To save a preset**: Choose whatever settings you want to use, then click the UI Settings window Option menu, and choose Save User Preferences as Preset. Enter a name into the dialog, and click OK. That preset will now appear at the top of the Option menu.
– **To load a preset**: Click the UI Settings window Option menu, and choose Load Preset from the submenu of the preset you want to load.
– **To update a preset**: Load a preset you want to edit, then change whatever settings you need to, and choose Update Preset from the submenu of that preset in the Option menu.
– **To export a preset**: Choose Export Preset from the submenu of any preset in the Option menu. A file with the .userprefs extension is saved at the location you chose.
– **To import a preset**: Choose Import User Preferences as Preset in the Option menu, use the dialog to find the exported .userprefs preset file you want to import, and click Open.
– **To delete a preset**: Choose Delete Preset from the submenu of any preset in the Option menu.
– **To reset all presets**: Choose Reset User Preferences from the Option menu to restore all User Preferences to their default settings.
UI Settings

A collection of operational preferences.

- **Language**: A Language drop-down at the top lets you specify which language the DaVinci Resolve user interface displays. DaVinci Resolve currently supports English, Chinese, Japanese, Spanish, Portuguese, French, Russian, Thai, and Vietnamese.

- **Reload last working project when logging in**: Automatically reopens the last project a user had open whenever that user logs back into DaVinci Resolve. This checkbox can only be enabled when editing a preset configuration in the Presets panel, so that it’s always on no matter which project you open as long as you’re using that particular preset. Ideally, enable it for your User config (if you’re using a multi-user configuration of DaVinci Resolve) or your Guest Default config (if you’re using a single-user configuration).

- **Show focus indicators in the User Interface**: Lets you enable or disable a red line at the top of each panel that indicates which panel currently has focus.

- **Use gray background for user interface**: By default, DaVinci Resolve uses a blue-gray UI background, intended to provide a more attractive experience for users focused on the less color-critical aspects of DaVinci Resolve, namely editing. Turning this checkbox on switches DaVinci Resolve to a totally neutral, desaturated gray UI, which can be valuable as a point of reference for colorists concerned about the blue-gray UI’s potential to bias the eye in the dark environment of the grading suite.

- **Use gray background in viewers**: When turned on, sets the background of all viewers to gray, making it easier to evaluate image blanking or minor sizing adjustments than with the default dark background.

- **Resize image in viewer to square pixels**: This control will select between using a square or non-square pixel aspect ratio within the Viewer. This is important when working with SD images which do not have a square pixel aspect ratio.

- **Delay viewer display by X frames**: When turned on, you can enter a number of frames to delay DaVinci Resolve Viewers as they appear on your computer displays so that the image on your computer display better syncs up with the same image shown on external displays that are delayed due to various signal processing processes.

- **Output single field when paused**: This setting will reduce flicker when grading using a computer monitor or when working with interlaced material. Ordinarily, when viewing interlaced material in Stop or Pause mode, field one is displayed followed by field two. Depending on the image, this can result in a flicker on the display. When this option is enabled, only field one will be shown on the monitor when playback is paused; however both fields will be shown when the clips are played.

- **Stop playback when a dropped frame is detected**: When enabled, sets DaVinci Resolve to stop playback whenever a frame is dropped on output, to warn you that there are performance issues on your workstation. This is particularly useful when you’re outputting to tape.

- **Stop renders when a frame or clip cannot be processed**: When enabled, this will halt a render if DaVinci Resolve detects an error in the encoding, rather than continue to try to process it.

- **Timeline sort order**: A user setting that allows you to determine the default sort order of the Timelines that appear in the Viewer drop-down menus throughout DaVinci Resolve.
  - **Alphabetic**: Sorts Timelines alphabetically A-Z.
  - **Creation Date**: Sorts Timelines by oldest creation date first.
  - **Recently Used (default)**: Sorts Timelines by the last actively used Timeline first.
Project Save and Load

The Project Save and Load panel lets you control how projects are opened, and how they’re saved.

Load Settings

The Load Settings preference lets you control a key aspect of project opening performance, namely whether or not all timelines within a given project are loaded into memory at the time of opening.

– **Load all timelines when opening projects:** To improve the performance of longer projects with multiple timelines, the “Load all timelines when opening projects” checkbox in the Project Save and Load panel of the User Preferences defaults to off.

  – When this checkbox is off, opening a project only results in the last timeline you worked on being opened into memory; all other timelines are not loaded into RAM. This speeds up the opening of large projects. However, you may experience brief pauses when you open other timelines within that project, as each new timeline must be loaded into RAM as you open it. If you open a particularly gigantic timeline, a progress bar will appear letting you know how long it will take to load. Another advantage of this is the reduction of each project’s memory footprint, which is particularly valuable when working among multiple projects using Dynamic Project Switching.

  – If you turn this on, all timelines will be loaded into RAM, and you’ll experience no pauses when opening timelines you haven’t opened already. However, projects with many timelines may take longer to open and save.

Save Settings

The Save settings allow you to control how DaVinci Resolve handles automated saving and project backups. These features can save you from the heartache of lost work resulting from an unexpected problem.

– **Live Save:** Enabled by default, Live Save is a progressive, fast, always-on autosave mechanism that “saves as you go.” All changes in the Cut, Edit, and Fairlight pages are saved as you make them. All changes in the Fusion and Color pages are automatically saved when you switch to another clip, and also periodically and invisibly in the background while you work to ensure that your work is saved even if you haven’t switched clips in a while.

– **Project Backups:** Turning on the Project Backups checkbox in the Project Save and Load panel of the User Preferences enables DaVinci Resolve to save multiple backup project files at periodic intervals, using a method that’s analogous to a GFS (grandfather father son) backup scheme. This can be done regardless of whether or not Live Save is turned on. Each project backup is a complete project file, excluding stills and LUTs.

Once you’ve enabled Project Backups for a long enough time, whatever saved project backups have been created are retrievable in the Project Manager via the contextual menu that appears when you right-click a project, by choosing Project Backups. Opening a project backup does not overwrite the original project; project backups are always opened as independent projects.
Project backups are only saved when changes have been made to a project. If DaVinci Resolve sits idle for any period of time, such as when your smart watch tells you to go outside and walk around the block, no additional project backups are saved, preventing DaVinci Resolve from overwriting useful backups with unnecessary ones.

Three fields let you specify how often to save a new project backup, while the fourth lets you choose where the backups will be saved.

- **Perform backups every X minutes:** The first field specifies how often to save a new backup within the last hour you’ve worked. By default, a new backup is saved every 10 minutes, resulting in six backups within the last hour. Once an hour of working has passed, an hourly backup is saved and the per-minute backups begin to be discarded on a first in, first out basis. By default, this means that you’ll only ever have six backups at a time that represent the last hour’s worth of work.

- **Hourly backups for the past X hours:** The second field specifies how many hourly project backups you want to save. By default, 8 hourly backups will be saved for the current day you’re working, which assumes you’re working an eight hour day (wouldn’t that be nice). Past that number, hourly backups will begin to be discarded on a first in, first out basis.

- **Daily backups for the past X days:** The third field specifies for how many days you want to save backups. The very last project backup saved on any given day is preserved as the daily backup for that day, and by default daily backups are only saved for five days (these are not necessarily consecutive if you take some days off of editing for part of the week). Past that number, daily backups will begin to be discarded on a first in, first out basis. If you’re working on a project over a longer stretch of time, you can always raise this number.

- **Project backup location:** Click the Browse button to choose a location for these project backups to be saved. By default they’re saved to a “ProjectBackup” directory on your scratch disk, although you could change this to a volume that better fits into your data backup methodology.

**NOTE:** When using this feature, the very first project backup that’s saved for a given day may be a bit slow, but all subsequent backups should be unnoticeable.
Editing
The settings in this panel affect new timeline settings, editorial default values, trim behaviors, timeline UI appearance, and frame interpolation settings.

New Timeline Settings
These settings define the presets that populate the New Timeline Options window whenever you create a new timeline.

- **Start Timecode**: You can change the Start Timecode if a specific start time is required.
- **No. of Video Tracks**: Enter how many video tracks you want to have. You can also drag within this field to adjust the number of video tracks with a virtual slider.
- **No. of Audio Tracks**: Enter how many audio tracks you want to have. You can also drag within this field to adjust the number of audio tracks with a virtual slider.
- **Audio Track Type**: Choose the channel mapping you want the new audio tracks to use.

Automatic Smart Bins
These settings let DaVinci Resolve automatically create Smart Bins whenever clips with relevant metadata appear in the Media Pool, or whenever such metadata is added to clips that are already in the Media Pool. You can choose which Smart Bins are automatically created via a series of checkboxes.

General Settings
These settings define the timing of resolve-generated effects and editing operations.

- **Standard generator duration**: Defines the default duration of generators you edit into the Timeline, in Seconds or Frames. The default value is 5 seconds.
- **Standard transition duration**: Defines the duration of transitions, in Seconds or Frames, that you add to an edit point in DaVinci Resolve. The default value is 1 second.
- **Standard still duration**: Defines the duration of stills that you import such as TIFF, PNG and other supported graphic file formats, in Seconds or Frames. The default value is 5 seconds.
- **Pre-roll time**: Determines how much of the Timeline before the current position of the playhead to play when using the Play Around command.
- **Post-roll time**: Determines how much of the Timeline after the current position of the playhead to play when using the Play Around command.
- **Default handles length**: The value used when creating a timeline with handles. The default is one second worth of frames.
- **Default fast nudge length**: The number of frames that are nudged when you use the Shift-Comma (,) and Shift-Period (.) keyboard shortcuts.
- **Pre-playhead shadow length**: The number of frames in the Timeline prior to the playhead covered by the Playhead Shadow, if enabled by choosing View > Show Playhead Shadow.
- **Post-playhead shadow length**: The number of frames in the Timeline after the playhead covered by the Playhead Shadow, if enabled by choosing View > Show Playhead Shadow.
- **Timeline overlay retains the last performed action**: Turn this checkbox on if you want DaVinci Resolve to always remember the last edit type you used in the Timeline Viewer Overlay, and highlight it on this Overlay whenever you drag another clip over the Timeline Viewer to let you know that the last edit you performed is the new default edit if you drop clips to the left of the overlay.
- **Always highlight current clip in the media pool**: When turned on, any clips at the position of the playhead on the Edit or Color pages will be automatically highlighted in the Media Pool.
– **Sync the Master Timeline to the current frame:** If you turned on “Automatically match master timeline with media pool” in the Color settings, then this option lets you make sure that whenever you open the Master Timeline, the playhead is at the same clip and frame that it was in the previous Timeline you were working on.

– **Show offline reference for timeline gaps:** If there’s a missing clip in a conformed timeline that results in a gap in the Timeline Editor, turning this option on sets DaVinci Resolve to show the corresponding frames of an “offline reference movie,” if one has been assigned to that timeline, instead of black. This can be helpful in emergency situations when you’re missing timeline clips right before a screening or review session; this feature lets you play or output the missing frames using the corresponding media from the offline reference movie, instead of outputting black. For more information on using and assigning Offline Reference Movies, see Chapter 56, “Preparing Timelines for Import and Comparison.”

– **Show offline reference for non-conformed edits:** If there’s missing media in a project that results in an unlinked clip in the Timeline Editor (represented by a red exclamation point overlay on that clip), turning this option on sets DaVinci Resolve to show the corresponding frames of an “offline reference movie,” if one has been assigned to that timeline, instead of black. This can be helpful in emergency situations when you’re missing source media right before a screening or review session; this feature lets you play or output the missing frames using the corresponding media from the offline reference movie, instead of outputting black. For more information on using and assigning Offline Reference Movies, see Chapter 56, “Preparing Timelines for Import and Comparison.”

– **Use custom safe area overlays:** When turned on, displays Action Area and Title Area fields that let you set a custom percentage for each. The default values are 93% for Action Area and 90% for Title Area.

– **Align audio edits to frame boundaries:** When turned on, the In and Out points of audio clips always align themselves with whole frame boundaries, just like video clips. When turned off, you can perform subframe audio edits to audio-only clips, or to linked audio when you’ve suspended linked selection.

**NOTE:** Even when Align audio edits to frame boundaries is turned off, if linked selection is on, you’ll be unable to make subframe edits while you’re resizing both the audio and video of linked clips.

---

### Color

The settings in this panel govern different behaviors in the Color page.

#### General Settings

Affect a variety of behaviors while working in the Color page.

– **Master reset maintains RGB balance:** Defines how the DaVinci control panel trackball/ring reset buttons reset primary color adjustments. When this option is turned off (the default), pressing the ALL Reset button returns the primary correction values to their default values. When this checkbox is turned on, then pressing the ALL Reset button (a) resets the YRGB values so that the overall values are kept and the ratio of YRGB to each other is maintained, and (b) pressing the RGB Reset button sets the three color channels to the average of what they were previously set to.

– **Wipe wraps when viewing reference stills:** Turning this on (the default) lets stills wrap around the edge of the screen while you’re adjusting the wipe using the mouse, rather than stopping at the screen’s edge. If you find this behavior awkward when trying to quickly create full-frame comparisons with stills to flip on and off, it can be disabled.
– High-Visibility Power Window Outlines: Turning this on sets Power Window outlines to be drawn as green (for the center shape) and yellow (for the softness shapes), to make these windows easier to see in certain circumstances, instead of the default white and gray.

– Mattes display high contrast black and white: When enabled, the HILITE command, which displays the current key, shows a black and white matte (i.e., high contrast) rather than the standard gray matte. For more information on this setting, and on use of the HILITE command, see Chapter 134, “Secondary Qualifiers.”

– Next scene switches to visible track: When grading a project with multiple tracks, you can use this option to alter the “next scene” command to work better in projects with multi-clip composites. With this option turned off, pressing NEXT SCENE on the DaVinci control panel, or using the Down Arrow keyboard shortcut, moves the playhead to the very next clip in the Thumbnail timeline, regardless of whether it’s in front of or behind another clip. Turning this option on causes the NEXT SCENE command to move the playhead to the clip in the highest track if the next clip is part of a multi-clip composite with multiple clips stacked over one another.

– Previous or Next node navigates only to correctors: Node navigation only selects corrector nodes and bypasses mixer, splitter and combiner nodes, etc.

– Preserve node numbers when adding nodes: Checking this box increments the node numbering by the order in which they are created, regardless of its position in the node tree. Unchecked reflows the node numbering automatically based on the node’s position in the tree.

– Always perform copy and paste on selected nodes: Bypasses the interface focus-based selection for copying and pasting full grades vs. individual nodes. When checked, DaVinci Resolve will only copy and paste between selected nodes regardless of the interface focus.

– Use Legacy Auto Color: As of DaVinci Resolve 16, the A button in the Color Wheels palette and the Shot Match command available from the Thumbnail Timeline contextual menu both now use advanced algorithms, based on the DaVinci Neural Engine, to provide superior results when automatically adjusting color balance and contrast. This checkbox lets you set the A button to use the older algorithm instead.

– Use Legacy Shot Match: As of DaVinci Resolve 16, the Shot Match command available from the Thumbnail Timeline contextual menu uses an advanced algorithm, based on the DaVinci Neural Engine, to provide superior results when automatically adjusting color balance and contrast. This checkbox lets you set the Shot Match command to use the older algorithm instead.

– Histogram Background on Grading Tools: This drop-down menu lets you turn the histogram that appears in the background of the Curves palette either Off, On based on the node’s Input (changes made to the curve do not affect the background histogram), or On based on the node’s Output (changes made to the curve do affect the background histogram).

– Automatically cue x frames into timeline clips: This setting affects the operation of the NEXT SCENE and PREV SCENE commands in the Color page. The default cue point when moving from one clip to the next is the first frame of each clip. Entering a value, in frames, in this field sets the default cue point to the specified number of frames after the first frame of each clip you move the playhead to. This can be convenient if the source material has black or camera rollup flashes at the beginning of every clip while you’re trying to grade dailies.

– Neighboring Clips in Split Screen: Lets you choose how many neighboring clips next to the current clips are shown in a grid in the Color page Viewer when you turn on the Neighbor Clips option of the Split-Screen shot comparison control.

– Switching clips: (this setting can also be changed from the Option menu in the Node Editor) When switching clips, DaVinci Resolve can switch to the same or another node in the node graph. The four options below determine which node is selected:
  – Selects last adjusted node: The default setting, where each clip in the Timeline retains its own independent node selection that’s remembered whenever you move back to that clip.
  – Selects first node: The first node is always selected when you move to another clip.
Selects last node: The last node is always selected when you move to another clip.

Selects same node: If the clip you've moved to has as many or more nodes as the last clip, the node of the same number will be selected. If the clip you've moved to has fewer nodes than the last clip, the next highest node will be selected.

Color picker: Changes the way that colors are selected when using the Secondary color correction controls. DaVinci Resolve is the normal and modern mode, however some colorists who are familiar with the legacy 2K prefer the DaVinci 2K mode.

Ripple Mode
This setting determines the behavior of the Ripple command that's initiated when using the RIPLE VALUE button on the DaVinci Advanced control panel.

Target clips are set to: The Ripple mode that's used when you press the Ripple Value button on the DaVinci control panel. For more information on using this function, see Chapter 139, "Grade Management."

Exact values changed: Changes made to the current clip are rippled to the specified clips using the exact parameters that were changed. For example, if the Master Gain level in the current clip is changed to 0.75 of its range, each clip you ripple will have a Master Gain level of 0.75. Only parameters you adjust are rippled.

Percent value changed: Changes made to the current clip are rippled to the specified clips by the percentage of change you made to the altered parameters. For example, if the current clip has a Master Gain level of 1.00 and is changed to 0.90 units, then the Master Gain level of each clip you ripple will have a relative reduction of 10% relative to its previous value.

Unit values changed: Changes made to the current clip are rippled to the specified clips by the same delta of change, using whichever units make sense for the affected parameter. For example, if the current clip had a Master Gain of 0.80 and you increased it to 0.90, each rippled scene’s Master Gain level increases by 0.10.

All values are copied: The current clip’s grade is rippled to the specified clips in its entirety. No comparison is made with the original clip’s parameters, and all memory parameters are rippled.

Printer Light Step Calibration
For film projects, when you have tight integration with a film lab, it is possible to adjust the printer light calibration sets to match the lab you are using. You should work with your lab technician to set up the Lab Aim settings, the Steps adjustments, which is an incremental value, and the Density Increment adjustment, which is the amount of correction applied within each step. Usually, the Step and Density values will be identical, but this will be up to your lab and your preference.

Fairlight
Video I/O Offset
The two preferences found in this section let you offset overall video playback up to 7 frames earlier than your audio playback, to account for situations where image processing applied to your video output is causing delays that make the video out of sync with your audio. For example, let’s say your video output is going through a video convertor that adds a 1 frame delay, and then connects to a video projector that adds another 1 frame of delay. You can set your Video Monitor Offset to 2 frames to compensate, so the audio/video sync is solid.

Video Monitor Offset: This drop-down menu lets you choose an offset from 0 to 7 frames.

Apply Offset during Jog and Shuttle: Turning this checkbox on ensures that the offset you choose is also applied when you use Jog and Shuttle to move through your program.
General Settings
The two preferences found in the General Settings section both let you customize the Loop Jog behavior that’s currently available only on the Fairlight page. Choosing Timeline > Loop Jog enables a brief sample preview to be heard while scrubbing the playhead through the Timeline. This can make it easier to recognize bits of dialog or music as you’re quickly scrubbing through tracks, in situations where you’re trying to locate specific lines or music cues. It also enables this brief sample preview to loop endlessly when you hold the playhead on a frame, so you can pause while scrubbing and hear (by default) the current 80 ms prior to the playhead as it loops. A pair of settings let you customize this behavior.

– **Loop Jog Alignment:** Three options let you choose whether you loop audio Pre the position of the playhead, Centered on the playhead, or Post the position of the playhead.

– **Loop Jog Width:** A field lets you choose how many milliseconds of audio to loop when Loop Jog is enabled. How many milliseconds of audio corresponds to one frame depends on the frame rate of the video. For example, at a frame rate of 25 fps, there are 1000/25 = 40 ms per frame, so the default value of 80 ms equals two frames of looping.

Playback Settings
These preferences let you improve realtime performance in DaVinci Resolve by disabling specific UI features and optimizing the quality of some operations.

– **Hide UI overlays:** When using a single GPU for both display and CUDA, OpenCL, or Metal processing, or if your display GPU is underpowered, or if you lack the PCIe bandwidth required for the currently specified resolution or frame rate, you may be able to improve real time performance by turning this option on. When enabled, onscreen controls such as the cursor, Power Window outlines, and split-screen views are disabled and hidden during playback. When playback is paused, all onscreen controls reappear.

– **Minimize interface updates during playback:** When enabled, gives priority to real time performance during playback by reducing user-interface updates. This is helpful when you’re creating complex grades on systems with low processing power, or when working on projects at high resolutions.

– **Performance Mode Automatic/Manual:** A trio of radio buttons let you choose between Automatic (default) and Manual (user selectable) behaviors when you turn on Performance Mode in DaVinci Resolve, or you can turn Performance Mode Off altogether. Set to Automatic, Performance mode automatically optimizes a variety of operations in a bid to balance performance with the necessary level of image quality, for fast onscreen performance while always maintaining the highest level of quality for video output. Set to Manual, there are three different settings you can choose to disable for instances where a particular performance tradeoff Resolve is making results in an undesirably noticeable reduction in image quality in Performance Mode:

  – **Optimized Sizing:** Relates to how image resizing is handled.

  – **Optimized Decode Quality:** Relates to how clip resolution vs. timeline resolution is handled.

  – **Optimized Image Processing:** Relates to how image processing operations are handled.

Control Panels
The parameters in this panel let you customize the functionality of the DaVinci Control panel. Some, but not all, of these settings apply to third party panels.
Panel Sensitivity

Lets you choose the orientation of red on the trackballs, how sensitive trackballs and rings are, and how sensitive the qualifier knobs are.

– **Classic DaVinci trackball alignment:** When enabled, this checkbox sets all color balance controls in DaVinci Resolve to the traditional orientation they’ve always used, which is close to, but not exactly the same as, the vectorscope alignment of hues. When disabled, the alignment of color balance controls is exactly the same as the vectorscope alignment of hues, which is similar to how other color grading applications work. You should choose the mode you’re most familiar with.

– **Grading style:** Controls the orientation of the trackballs relative to the corrections they make. There are two options:
  – **DaVinci:** Most users will be familiar with the standard DaVinci controls as this mimics the vectorscope (how closely depends on the Classic DaVinci trackball alignment setting).
  – **Rank:** The Rank settings are somewhat different, so this option is for users who are familiar with color controls that the Rank control system offered. In this mode, the orientation of red and green are reversed.

– **Lift RGB balance:** Controls how quickly adjustments made to the Lift trackball (on the left) will adjust the Lift Color Balance parameters in the Color page. This setting affects third-party panels.

– **Lift master:** Controls how quickly adjustments made to the Lift ring (surrounding the leftmost trackball) will adjust the Lift Contrast parameter in the Color page. This setting affects third-party panels.

– **Gamma RGB balance:** Controls how quickly adjustments made to the Gamma trackball (second from the left) will adjust the Gamma Color Balance parameters in the Color page. This setting affects third-party panels.

– **Gamma master:** Controls how quickly adjustments made to the Gamma ring (surrounding the second trackball from the left) adjust the Gamma parameter in the Color page. This setting affects third-party panels.

– **Gain RGB balance:** Controls how quickly adjustments made to the Gain trackball (third from the left) will adjust the Gain Color Balance parameters in the Color page. This setting affects third-party panels.

– **Gain master:** Controls how quickly adjustments made to the Gain ring (surrounding the third trackball from the left) will adjust the Gain Contrast parameter in the Color page. This setting affects third-party panels.

– **Cursor offset:** Controls how quickly adjustments made to the fourth trackball affect the cursor, window position, log-mode offset, and other controls that can be manipulated via this trackball.

– **Cursor master:** Controls how quickly adjustments made to the fourth ring affect log-mode master offset, and other controls that can be manipulated via this ring.

– **Hue/Saturation/Luminance qualifier:** Controls the sensitivity of the HSL panel control knobs.

– **Jog:** Controls the sensitivity of the jog wheel.

– **Shuttle:** Controls the sensitivity of the shuttle dial.

Display Settings

Lets you adjust the display of your Blackmagic Design control panels.

– **LCD brightness:** Controls the overall brightness of the DaVinci control panel displays.

– **Key backlighting:** Depending on which control panel you have selected, two controls let you choose LCD Brightness and Key backlighting of the DaVinci Resolve Mini panel, or three controls let you adjust the color balance of the lit buttons of the DaVinci Resolve Advanced control panel (the default is red).
Metadata

The metadata panel lets you create custom sets of metadata parameters that will be exposed in the Metadata Editor. For more information on using this panel, see Chapter 18, “Using Clip Metadata.”

Keyboard Customization

Choosing DaVinci Resolve > Keyboard Customization opens the standalone Keyboard Customization window. This window lets you choose which set of keyboard shortcuts you want to use, discover which keyboard shortcuts are available, or create your own custom keyboard mappings that more closely adhere to the way you like to work, in whichever pages you find yourself working.

Choosing Keyboard Shortcut Emulation Presets

Using a drop-down at the top right of this menu, you can choose the default DaVinci Resolve set or any one of the other sets that attempt to mimic other NLEs you might be more familiar with. Please note that keyboard shortcuts can only be remapped to commands that functionally exist within DaVinci Resolve, so if a specific feature of another NLE does not have an equivalent in DaVinci Resolve, that key shortcut may not be mapped in the same way. Fortunately, the editorial feature set of DaVinci Resolve broadly overlaps with common features in other NLEs, so you should find that most features you’re used to have a functional equivalent.
You also have the ability to create your own custom sets of keyboard shortcuts. The Commands list below shows a hierarchical list of commands organized by the menu they appear within. This list lets you select individual commands to remap and can be searched if you’re having a hard time finding what you’re looking for. This is described in more detail later in this section.

**Viewing Commands Assigned to Specific Key Combinations**

To see what command a particular key of the keyboard is mapped to, you can click any combination of modifier and other keys on the virtual keyboard at the top of this window. The currently selected keys reveal how they’re mapped in the “Active Key” list below.

![Virtual Keyboard](image)

TIP: Starting in DaVinci Resolve 15.2, commands can have multiple keys or key combinations assigned to them, and number keys on the numeric keypad of an extended keyboard can be assigned independently from keys at the top of a keyboard.

**Panel-Specific Keyboard Mappings**

When customizing keyboard shortcuts, they can be assigned to the “Application” so that shortcut works identically within every part of the DaVinci Resolve UI that’s applicable, or you can map a particular keyboard shortcut to do a particular command within a specific panel.

Panel-specific keyboard shortcuts let you use a single key to do different things depending on which panel has focus; for example, one key can do different things in the Media Pool, the Edit Timeline, the Metadata Editor, and the Sound Library, to give a few Edit Page examples. This provides enormous flexibility, but if you go this route, you need to be aware of which panel has focus. Fortunately, starting in DaVinci Resolve 15.2, focus is indicated by a colored highlight at the top of each panel.

![Panel-Specific Keyboard Mappings](image)
Searching for Keyboard Shortcuts

Whether you're looking to see what keyboard shortcuts are available or looking for a particular command you want to customize, a Search field above the Commands list is available for searching whichever group of commands you want (including All Commands).

To search for specific keyboard shortcuts:

1. Choose DaVinci Resolve > Keyboard Customization.
2. Choose a command group from the Commands list to search within. If you want to search all of DaVinci Resolve, choose “All Commands.”
3. Type a term into the Search field, and the Command/Keystroke list will update to show whatever commands match the search criteria you’ve entered.

Managing Keyboard Mappings

DaVinci Resolve provides the following methods for creating and managing keyboard mappings in the Option menu of the Keyboard Customization menu:

- **To create a new keyboard mapping:** Choose a keyboard mapping from the drop-down to use as your starting point, choose Save As New Preset from the Keyboard Customization Option menu, then enter a preset name in the dialog, and click OK. That preset will now appear in the preset drop-down menu.

- **To export a keyboard shortcut file for use by another DaVinci Resolve workstation:** Choose a preset from the Export Preset submenu of the Keyboard Customization Option menu, then choose a name and a location for the new file, and click Save.
To import a keyboard shortcut file: Choose Import Preset from the Keyboard Customization Option menu, choose a DaVinci Resolve keyboard shortcut file, and click Open.

To delete a keyboard mapping: Choose a keyboard mapping preset you want to delete, then click the trash can button.

Remapping a Command to One or More Keys

Changing the keyboard mapping for any given command is easy. You can even map a single command to multiple keys, if necessary.

To change the keyboard shortcut for a particular command:

1. Find the command you want to remap in the Commands list by selecting a category. If necessary, use the Search field. Whether a command is mapped generally to the entire application or specifically to a particular panel depends on what you’ve selected from the list.
   a. If you want the keyboard character you plan to map to work application-wide, choose a menu name from underneath the Application category of the Commands list. Each menu shows all commands associated with it and can be individually searched.
   b. If you want the keyboard character you plan to map to this command to be specific to a particular panel, then choose one from the Panels category underneath. Each panel shows all commands associated with it and can be individually searched.

2. Click within the Keystroke column of the list, to the right of the command, and when a selection appears type a new character using any combination of modifier keys you like.

Clicking to select a keyboard shortcut you want to modify

Please note that if you remap a key that was already assigned to another command, you’ll see a warning that the key you’re about to remap is already assigned to another command, giving you a chance to cancel and change key assignments if you like.
The warning you see if you try to map the same key to multiple commands

You can override the warning and make the assignment, but having the same character or combination applied to multiple commands can cause problems, so a warning badge appears next to affected commands, making it easy to see where the duplicate is, so you can remap one or the other command as necessary.

3 (Optional) You also have the option of assigning multiple keyboard shortcuts to a single command. For example, if you want to use keys on the numeric keypad of an extended keyboard in addition to other keys for a particular command, you can now set this up by clicking the “plus” button to the right of a currently assigned keyboard shortcut. This makes another highlight appear, within which you can type any secondary character or combination you like to make the additional assignment. You can do this as many times as you like. When you’re done, all keyboard shortcuts applied to that command appear, separated by commas.

You can map multiple keys to the same command, if necessary

4 When you’re finished changing keyboard shortcuts, click the Save button at the bottom right of the Keyboard Mapping list, and then click Cancel to close the window.
Chapter 5

Project Settings

This chapter covers the settings used for defining the properties of each individual project. It’s a good idea to familiarize yourself with the information in this chapter prior to setting up your first project.

Contents

What Are the Project Settings? 112
Opening and Editing Project Settings 112
Presets 113
Master Settings 114
Timeline Format 114
Video Monitoring 116
Optimized Media and Render Cache 117
Working Folders 118
Frame Interpolation 118
Image Scaling 119
Image Scaling 119
Input Scaling 120
Output Scaling 120
Color Management 121
Color Space and Transforms 121
Dolby Vision™ 122
HDR10+ 123
Lookup Tables 123
Broadcast Safe 125
General Options 125
Conform Options 125
Color 127
Dynamics Profile 128
Versions 129
Camera Raw 129
Capture and Playback 129
Deck Settings 129
Capture 130
Playout 131
Subtitles 132
Fairlight 132
Audio Metering 132
Immersive Audio 133
What Are the Project Settings?

The Project Settings window contains all project-specific parameters that are saved along with that project. These include essential project properties such as the timeline format, video monitoring settings, how to optimize media, and where to save cache files. It also includes image scaling properties, color management settings, and many other properties that affect projects in fundamental ways.

Opening and Editing Project Settings

All of these project-specific settings are easily accessed from anywhere in DaVinci Resolve by clicking the gear button at the bottom right of the page bar.

The Project Settings window opens in the middle of the screen.

The Project Settings window is divided into a series of panels which can be selected from a sidebar at the left. Each panel contains a collection of related settings that affects some category of DaVinci Resolve functionality.
To alter project settings:

1. Click on the name of any group of settings in the sidebar at the left to open that panel.
2. Change whatever settings you need to change.
3. Do one of the following to apply your changes:
   - Click Save to apply the changes you’ve made and close the Project Settings.
   - Option-click Save to apply the changes you’ve made and keep the Project Settings window open, so you can make other changes. This option is available because it’s sometimes necessary to keep the Project Settings window open as you continue making changes that may visibly affect the clips and timelines in your project.

Presets

The Presets panel lets you save customized collections of Project Settings for future recall. Presets can save the state of nearly every parameter and setting in every panel of the Project Settings window, and make it easy to switch among different setups for different tasks, or to accommodate different types of projects.

There are three default items in the Presets list:

- **Current Project:** The current project’s settings. If you load a preset, the current project becomes selected, showing that the preset you loaded has been applied to the current project.

- **System Config:** The System Config contains the default Project Settings that are used for all new projects that you create, and consists of the installed defaults that accompanied DaVinci Resolve. This config is uneditable, but you can use the Save As button to duplicate it as the basis for a new preset.

- **Guest default config:** This setting is a holdover from previous versions of DaVinci Resolve that had multi-user support. The default configuration for all new projects created by the currently logged in user. The actual name of this config reflects the current user name. This config can no longer be altered.

If you like, you can create your own presets, adding as many as you need to accommodate the types of projects you work on.

To create a new preset:

1. Do one of the following:
   - Right-click a project in the Project Manager, and choose Project Settings from the contextual menu.
   - Open any project, then open the Project Settings, and select the Presets panel.

2. Select any config in the Presets list that you want to use as the starting point of a new project preset, and click Save As.

3. Enter a name for the new preset you’re creating into the Preset Name dialog, and click OK. A new preset should now appear in the Presets list.

4. Select the new preset you’ve just created.

5. Now, use the different panels of the Project Settings window to alter whichever settings you need to. There’s no need to save your changes as you go, you’ll save them all at once later.

6. When you’re finished customizing the Project Settings, reopen the Presets panel and click Save. Your new preset is updated with the new settings you’ve chosen.

Once you’ve created one or more custom presets, you can load them into a project at any time.
To load a preset’s settings into a project:
1. Open a project with a preset you want to update.
2. Click an item in the Presets list.
3. Click Load.
   If a dialog appears saying either “Do you want to replace current project's config with this selected Preset” or “Apply Current Configuration to System?”, click Yes.
4. If there’s a custom preset that you’ve created that has outlasted its usefulness, you can delete it.

To delete a custom preset:
1. Do one of the following:
   – Right-click a project in the Project Manager, and choose Project Settings from the contextual menu.
   – Open any project, then open the Project Settings, and select the Presets panel.
2. Click an item in the Presets list to select it.
3. Click Delete.
4. When the Confirm Delete dialog appears, click Yes.

Master Settings

This panel is project specific and lets you set up and adjust the most essential properties of the timelines in your project, including the timeline format, video monitoring method, and conform options. In many workflows, you’ll want to adjust these settings before getting started with your project.

By default, all timelines use these project-wide settings. However, beginning with DaVinci Resolve 16, you can optionally create timelines with individual Format, Monitoring, and Output Sizing settings. However, if you change a timeline to use “Basic Settings,” then that timeline will mirror the project-wide options that are selected in the Project Settings.

Timeline Format

This group of settings affects the geometry and image processing of the current project.

– **Timeline resolution**: A drop-down menu that lets you choose a frame resolution preset to use for image processing while grading. DaVinci Resolve is resolution independent, so you can change the resolution at any time and all windows, tracks, sizing changes, and keyframe data will be automatically recalculated to fit the new size. For example, you can work on a 4K project while monitoring at HD resolutions if your room is only set up with an HD monitor, and then render the finished project at 4K resolution for final delivery. Alternately, you can downsize an HD project to an SD resolution to create another set of deliverables. For more information on Resolve’s resolution independence, see Chapter 150, “Sizing and Image Stabilization.”

– **Frame size (Labeled “For X x Y processing”)**: Lets you set resolutions not found in the “Timeline resolution” drop-down menu.

– **Pixel aspect ratio**: Used to select PAR settings for image formats that don’t use the default square pixel format. You can apply a 16:9 anamorphic PAR, a 4:3 PAR for SD projects, or a Cinemascope ratio.
– **Timeline frame rate**: Determines the primary frame rate used by the project. A variety of standard and high frame rate (HFR) settings are available. If you’re importing an AAF or XML file, this setting is automatically set via an option in the Project Import dialog. Ideally, you should choose a frame rate before importing media into the Media Pool. However, the first time you import media into an empty Media Pool, you’re prompted if the incoming media frame rate doesn’t match the Timeline frame rate set here, and you have the option of automatically updating this setting to match that of the media you’re importing. Once one or more files have been added to the Media Pool, this setting cannot be changed.

– **Use drop frame timecode**: Enables or disables drop frame timecode for the current project. Off by default.

– **Enable interlace processing**: Interlaced media is supported throughout DaVinci Resolve. The “Enable interlace processing” checkbox forces DaVinci Resolve to process all operations internally using separated fields, in order to properly maintain the field integrity of interlaced clips in your program. In addition, each clip in the Media Pool has a Field Dominance drop-down menu in the Video panel of the Clip Attributes window that lets you specify whether clips are upper- or lower-field dominant; an Auto setting makes this choice by default.

There is also a corresponding checkbox in the Render Settings panel of the Deliver page, named “Field rendering,” that lets you enable and disable field rendering when you’re rendering file-based output.

There are two instances where you want to leave this setting turned off:

– If you’re working with progressive-frame media, it is not necessary to turn this checkbox on. Doing so will unnecessarily increase processing time.

– If you’re using interlaced clips in a progressive-frame project and you’re intending to deinterlace those clips using the Enable Deinterlacing checkbox in the Clip Attributes window, then you must keep “Enable video field processing” off. Otherwise, the Enable Deinterlacing checkbox will be disabled for all clips. For more information about deinterlacing clips, see Chapter 21, “Modifying Clips and Clip Attributes.”

If you’re working on a project with interlaced media that you intend to keep interlaced, then whether or not it’s necessary to turn field processing on depends on what types of corrections you’re applying to your clips. If you’re mastering your program to an interlaced format, and you’re applying any adjustments that would cause pixels from one field to move or bleed into adjacent fields, then field processing should be enabled; effects requiring field processing include filtering operations such as blur, sharpen, and OpenFX operations, as well as sizing transforms that include pan, tilt, zoom, rotate, pitch, and yaw.

On the other hand, regardless of whether you’re outputting interlaced or progressive-frame media, if you’re not filtering or resizing your clips, and you’re only applying adjustments to color and contrast, it’s not necessary to turn on field processing for interlaced material, and in fact, leaving it off may somewhat shorten your project’s rendering time.

– **Playback frame rate**: Usually mirrors the frame rate selected in the “Video format” setting (in the Video Monitoring section below), which is typically based on the frame rate of the external display that’s connected to your video interface, given the “Timeline Frame Rate” setting. For example, a 50Hz monitor requires a 25 fps playback frame rate for synchronous display without dropped frames. If you want to monitor playback at a slower frame rate, type the frame rate of your choice in this field and DaVinci Resolve will make the appropriate calculations to drop or repeat frames as necessary to match it. This can be useful for temporarily seeing how clips look in slow motion.
Video Monitoring

The settings available in this group control the signal that’s output by the video output interface that’s connected to your workstation, and let you specify what standard of signal is output, and via which signal path.

By default the frame size and frame rate match those in the Timeline resolution and Playback frame rate options. However, if necessary you can change these settings to match those of the external display you’re using to monitor your work. For example, if you’re working with 2K files for 2K output, but you’re color correcting using a high definition monitor set to 1080 resolution, you can select the appropriate HD standard for that monitor without changing the Timeline Resolution settings.

- **Video format**: Lets you choose a video standard combination of frame size and frame rate to be output via your connected video output interface.

- **Video connection checkboxes**: Lets you choose the signal standard to output from your connected video output interface to the video monitor. Make sure to choose a standard that’s supported by both your video interface and your monitor. The options are:
  - **Use 4:4:4 SDI**: A signal path for monitoring image data to monitors that supports 4:4:4 chroma sampling, typically over SDI connections.
  - **Use Level A for 3Gb SDI output**: A signal path for monitoring image data via a single 3 Gb/s SDI connection.
  - **Use dual outputs on SDI output**: All DaVinci Resolve systems can generate a side-by-side display that can be sent to a Stereoscopic monitor via the HD-SDI output of an UltraStudio 4K or DeckLink card. When dual SDI 3D monitoring is enabled, each eye is output separately at full resolution. In this mode, split-screen wipes and cursors will not be visible on the grading monitor.

- **SDI Configuration**: Lets you choose from among Single Link, Dual Link, and Quad Link SDI, depending on what your display supports.

- **Data Levels**: This setting only affects the data levels being output via the video interface that connects the DaVinci Resolve workstation to your external display. It has no effect on the data that’s processed internally by DaVinci Resolve, or on the files written when you render in the Deliver page. It is imperative that the option you choose in DaVinci Resolve matches the data range to which your external display is set. Otherwise, the video signal will appear to be incorrect, even though the internal data is being processed accurately by DaVinci Resolve. There are two options:
  - **Video**: This is the correct option to use when using a broadcast display set to the Rec. 709 video standard.
  - **Full**: If your monitor or projector is capable of displaying “full range” video signals, and you wish to monitor the full 10-bit data range (0–1023) while you work, this is the correct option to use.

For more information about data levels, see Chapter 8, “Data Levels, Color Management, and ACES.”

- **Retain sub-black and super-white data**: Turning this checkbox on lets DaVinci Resolve output the undershoots (sub-black) and overshoots (super-white) within the headroom of video encoded data levels to video. When this is turned off, these out-of-bounds values are clipped in video output.

- **Video bit depth**: Choose the bit depth that corresponds to the capability of your display. You can choose between 8-bit and 10-bit. Monitoring in 10-bit is more processor intensive, but preferable to avoid the appearance of banding that may not in fact be in the image data being processed by DaVinci Resolve.
Monitor scaling: Defaults to basic, and is only enabled to smooth the edges of video being viewed on a projector with very large screens. These settings minimize high frequency artifacts that may be seen. This may also be noticeable if you have a 2K or HD project but are monitoring on an SD monitor. The other option, Bilinear, has different effects on the monitored image depending on your display device, so you may need to check to verify that it’s appropriate for your environment.

Use Rec601 Matrix for 4:2:2 SDI output: Don’t use this checkbox unless you know what it does. You know who you are.

Enable HDR metadata over HDMI: (only available in Studio version) Turning on this checkbox outputs the metadata necessary to send High Dynamic Range signals over HDMI 2.0a and have it be correctly decoded by an HDR-aware video display. When this checkbox is enabled, it’s recommended to also enable the “HDR mastering is for X nits” checkbox in the Color Management page, and set the “nit” level (slang for cd/m²) to whatever peak luminance level your HDMI connected HDR display is capable of.

Optimized Media and Render Cache

These settings govern the resolution and codec of optimized media that DaVinci Resolve can generate in order to facilitate greater real time performance, as well as cached media that’s generated by the Smart and User Cache.

Proxy media resolution: A drop-down list lets you choose whether to generate proxy media at each clip’s Original size, or at Half, Quarter, One-Eighth, or One-Sixteenth the resolution of the original media, or allow DaVinci Resolve to choose this automatically for you based on your timeline settings.

Proxy media format: Specifies the format in which proxy media files will be written. You can choose from among a variety of Uncompressed, ProRes, and DNxHD formats, depending on your requirements.

Optimized media resolution: A drop-down list lets you choose whether to generate optimized media at each clip’s Original size, or at Half, Quarter, One-Eighth, or One-Sixteenth the resolution of the original media, or allow DaVinci Resolve to choose this automatically for you based on your timeline settings.

Optimized media format: Specifies the format in which optimized media files will be written. You can choose from among a variety of Uncompressed, ProRes, and DNxHD formats, depending on your requirements.

Render cache format: Specifies the format in which render cache files will be written. You can choose from among a variety of Uncompressed, ProRes, and DNxHD formats, depending on your requirements.

Enable background caching after X seconds: Specifies the duration of inactivity after which automatic background caching will begin.

A series of checkboxes let you force specific types of effects to be cached when you use the User Cache, which is a more selective manner of caching than the Smart Cache. These include:

Automatically cache transitions in User Mode: If you’re using User mode and you find that your workstation does not have adequate performance to play transition effects in real time, you can force these categories of effects to be automatically included in the Sequence Cache and cached when you’re using the User mode of caching.

Automatically cache composites in User Mode: If you’re using User mode and you find that your workstation does not have adequate performance to play composite mode or opacity effects in real time, you can force these categories of effects to be automatically included in the Sequence Cache and cached when you’re using the User Mode of caching.

Automatically cache Fusion Effects in User Mode: If you’ve created effects for a clip in the Fusion page and you find that your workstation does not have adequate performance to play that clip in real time, you can force these categories of effects to be automatically included in the Sequence Cache and cached when you’re using the User Mode of caching.
Working Folders

These fields let you specify to which folders cache and gallery files are written.

- **Proxy generation location:** All proxy media files that you create are saved in the directory path specified by this field.

- **Cache files location:** All render cache files that you create are saved in the directory path specified by this field. This path defaults to a hidden “CacheClip” directory that’s created at the location of the first Media Storage Volume you specify in the DaVinci Resolve Preferences window.

- **Gallery stills location:** By default, all stills you save are saved in the DPX format, and are placed in the directory path specified by this field. This path defaults to a hidden “.gallery” directory that’s created at the location of the first Media Storage Volume you specify in the DaVinci Resolve Preferences window.

**NOTE:** If the volume you’ve selected to use for the cache becomes unavailable, DaVinci Resolve will warn you with a dialog.

Frame Interpolation

These settings determine the default state for all retiming and speed change effects, including when clips are in mixed frame rate timelines.

- **Retime Process:** This drop-down menu lets you choose a default method of processing clips that don’t match the project frame rate in mixed frame rate timelines and clips with speed effects (fast forward or slow motion) applied to them, throughout the project. Since each clip in every timeline defaults to “Project Settings,” changing this setting will change the way most mixed frame rate and speed effected clips will be processed, except for those with custom settings selected. There are three options:
  - **Nearest:** The most processor efficient and least sophisticated method of processing; frames are either dropped for fast motion, or duplicated for slow motion.
  - **Frame Blend:** Also processor efficient, but can produce smoother results; adjacent duplicated frames are dissolved together to smooth out slow or fast motion effects. This option can provide better results when Optical Flow displays unwanted artifacts.
  - **Optical Flow:** The most processor intensive, but highest quality method of speed effect processing. Using motion estimation, new frames are generated from the original source frames to create slow or fast motion effects. The result can be exceptionally smooth when motion in a clip is linear. However, two moving elements crossing in different directions or unpredictable camera movement can cause unwanted artifacts.

- **Motion estimation mode:** When using mixed frame rate clips in a timeline that has Optical Flow retiming enabled, when using Optical Flow to process speed change effects, or when using Image Stabilization or Temporal Noise Reduction controls in the Color page, the Motion Estimation drop-down of the Master Settings (in the Project Settings window) lets you choose options that control the trade-off between speed and quality.

There are additional “Enhanced” Optical Flow settings available in the “Motion estimation mode” drop-down in the Master Settings panel of the Project Settings. The “Standard Faster” and “Standard Better” settings are the same options that have been available in previous versions of DaVinci Resolve. They’re more processor-efficient and yield good quality that are suitable for most situations. However, “Enhanced Faster” and “Enhanced Better” should yield superior results in nearly every case where the standard options exhibit artifacts, at the expense of being more computationally intensive, and thus slower on most systems.
New improved Motion estimation mode settings in the Master Settings panel of the Project Settings

- **Motion range:** When using mixed frame rate clips in a timeline that has Optical Flow retiming selected, or when using Optical Flow to process speed change effects, this drop-down menu lets you choose the default setting to use, small, medium or large motion, for all speed and motion related calculations so you can try and improve the result by matching the type of motion in the source media. This setting can also be changed on a clip by clip basis in the Edit page Inspector.

### Image Scaling

The Image Scaling panel contains settings that determine how and when clips are resized for various reasons.

#### Image Scaling

These settings affect the methods used to resize clips in various situations.

- **Resize Filter:** The first group of settings lets you choose the filter method used to interpolate image pixels when resizing clips:
  - **Smoother:** May provide higher quality for projects using clips that must be scaled down to fit an SD resolution frame size.
  - **Bicubic:** While the Sharper and Smoother options are slightly higher quality, Bicubic is still an exceptionally good resizing filter and is less processor intensive than either of those options.
  - **Bilinear:** A lower quality setting that is less processor intensive. Useful for previewing your work on a low-performance computer before rendering, when you can switch to one of the higher quality options.
  - **Sharper:** Usually provides the best quality in projects using clips that must be scaled up to fill a larger frame size or scaled down to HD resolutions.
  - **Custom:** This setting lets you take control of the exact algorithm used in all resizing operations. The custom Resize Filter options available are: Bessel, Box, Catmul-Rom, Cubic, Gaussian, Lanczos, Mitchell, Nearest Neighbor, Quadratic, and Sinc. In practice, the difference between these methods can be quite subjective. However, if you need to match a specific resizing method used from another application, you can do it here. For everyday use, the normal resizing filters in DaVinci Resolve should be sufficient.

- **Override input scaling:** Checking this box lets you choose an Input Sizing preset to apply to the project.

- **Override output scaling:** Checking this box lets you choose an Output Sizing preset to apply to the project.
– **Anti-alias edges**: A second group of settings lets you choose how to handle edge anti-aliasing for source blanking.

  – **Auto**: Adds anti-aliasing when any of the Sizing controls are used to transform the image. Otherwise, anti-aliasing is disabled.
  – **On**: Forces anti-aliasing on at all times.
  – **Off**: Disables anti-aliasing. It might be necessary to turn anti-aliasing off if you notice black blurring at the edges of blanking being applied to an image.

– **Deinterlace quality**: (only available in Studio version) A fourth group of settings lets you choose the quality/processing time tradeoff when deinterlacing Media Pool clips using the Enable Deinterlacing checkbox in the Clip Attributes window. There are two settings:

  – **Normal**: A high-quality deinterlacing method that is suitable for most clips. For many clips, Normal is indistinguishable from High. Normal is always used automatically during playback in Resolve.
  – **High**: A more processor-intensive method that can sometimes yield better results, depending on the footage, at the expense of slower rendering times.
  – **DaVinci Neural Engine**: This option uses the advanced machine learning algorithms of the DaVinci Neural Engine to analyze motion between the fields of interlaced material and reconstructs them into a single frame. This option is very computationally intensive but, ideally, will deliver an even more aesthetically pleasing result than the “high” setting.

### Input Scaling

Contains one setting, Mismatched resolution files, that lets you choose how clips that don’t match the current project resolution are handled. There are four options:

  – **Center crop with no resizing**: Clips of differing resolution are not scaled at all. Clips that are smaller than the current frame size are surrounded by blanking, and clips that are larger than the current frame size are cropped.
  – **Scale full frame with crop**: Clips of differing resolution are scaled so that the clip’s shortest dimension is fit to match the frame. Excess pixels are cropped.
  – **Scale entire image to fit**: The default setting. Clips of differing resolution are scaled so that the clip’s longest dimension is fit to match the frame. The shorter dimension has blanking inserted (letterboxing or pillarboxing).
  – **Stretch frame to all corners**: Useful for projects using anamorphic media. Clips of differing resolutions are squished or stretched to match the frame size in all dimensions. This way, anamorphic media can be stretched to match full raster, or full raster media can be squished to fit into an anamorphic frame. An added benefit of this setting is that it makes it easy to mix anamorphic and non-anamorphic clips in the same project.

### Output Scaling

These settings let you optionally choose a different resolution to be output via your video output interface, for monitoring, outputting to tape, or rendering. In particular, if you set the resolution in the Render Settings list of the Deliver page to something other than the Timeline Resolution, these settings are used to make the change (for example, if you’re rendering a downconversion of the current timeline). This can be used in situations where you’re working on a high resolution 4K project, but you want to monitor using an HD display and output HD resolution media for approval.
– **Match timeline settings:** Turned on by default, so that these settings mirror the Timeline Resolution, Image Scaling, and Input Image Scaling settings described above. Turning this checkbox off lets you choose different settings for monitoring, outputting to tape, or rendering, using the other settings in this group.

– **Output resolution:** Lets you choose an alternate resolution.

– **For:** Lets you specify a different custom alternate resolution.

– **Pixel aspect ratio:** Lets you specify an alternate pixel aspect ratio to match the alternate timeline format.

– **Mismatched resolution files:** Lets you choose an alternate way of handling mismatched resolution files given the alternate resolution you've chosen. These options work identically to those of the “Input Image Scaling” group.

– **Super Scale:** Sets a very processor-intensive and high quality upscaling algorithm that actually creates new pixels for the resized image. The possible values are: None, 2x, 3x, 4x, and Auto. For more information on Super Scale, see Chapter 10, “Image Sizing and Resolution Independence.”

### Color Management

The various options found in the Color Management panel let you configure DaVinci Color Management (RCM) or ACES if you have either enabled, and they also allow you to pre- or post-process the DaVinci Resolve image processing pipeline using LUTs and Broadcast Safe settings, in order to accommodate a wide range of different color workflows.

### Color Space and Transforms

If you choose DaVinci YRGB Color Managed or ACES in the Color Science menu at the top, then the other drop-down menus in this section become enabled. For more information about DaVinci Resolve Color Management and ACES, see Chapter 8, “Data Levels, Color Management, and ACES.” If you’re new to color or color management, you’re strongly recommended to read this chapter.

If you choose to use Resolve Color Management (RCM), ACEScc, or ACEScct, the settings in this panel give you extensive control over how color is transformed, starting with choosing the default color settings for the source media in your project (via the Input Color Space), through choosing how you want your grading controls in DaVinci Resolve to behave (via the Timeline Color Space), and then specifying how the final color will look on your monitor and output device (via the Output Color Space).

– **Color science:** There are four options that let you choose whether to work with manual or automated color management.

  – **DaVinci YRGB color science:** DaVinci Resolve’s original color science, in which you manage all and any color transforms from one color space to another manually, using either LUTs or manual adjustments.

  – **DaVinci YRGB Color Managed:** Enables the Resolve color-managed workflow (RCM) for grading.

  – **DaVinci ACEScc or ACEScct:** Both of these are standardized color management schemes that are available for facilities using ACES workflows. Of the available settings, ACEScct is the most intuitive way of working for most colorists, as it handles the lifting of shadows in a creatively useful way. For more information about Color Management and ACES, see Chapter 8, “Data Levels, Color Management, and ACES.”
– **ACES version**: This drop-down only appears if you choose one of the DaVinci ACES options from the Color science drop-down menu. Lets you switch between different versions of the ACES specification. This lets you choose the appropriate older version of ACES whenever you open an older project. As of DaVinci Resolve 14, ACES 1.0.3 is the minimum supported version. In version 16, DaVinci Resolve also supports ACES 1.1.

– **Use Separate Color Space and Gamma**: If this checkbox is turned off (the default), the Color Management panel of the Project Settings exposes one drop-down each for the Input, Timeline, and Output Color Space settings, and each setting simultaneously transforms the gamut and gamma, depending on which option you choose. If you turn this checkbox on, then the Color Management panel changes so that the Input, Timeline, and Output Color Space settings each display two pop-ups. The first drop-down lets you explicitly set the gamut, while the second drop-down lets you explicitly set the gamma.

To provide more detailed information, the simple and advanced global controls available for Resolve Color Management (RCM) are covered in a dedicated chapter. For more information, see Chapter 8, “Data Levels, Color Management, and ACES.”

**Dolby Vision™**

DaVinci Resolve includes a GPU-accelerated software version of the Dolby Vision CMU (Content Mapping Unit) for doing Dolby Vision grading and finishing workflows right in either the free version of DaVinci Resolve or in DaVinci Resolve Studio. This is enabled and set up in the Color Management panel of the Project Settings with the Enable Dolby Vision checkbox.

There are five controls available:

– **Enable Dolby Vision**: Turns Dolby Vision on and off. When on, this checkbox enables the Dolby Vision palette in the Color page.

– **Dolby Vision version drop-down**: Lets you choose which version of the Dolby Vision algorithms to use. Options at the time of this writing include 2.9 and 4.0.

– **Master Display drop-down**: Lets you choose the nit level and gamut of the master HDR display you’re grading on.

– **Use External CMU**: A checkbox lets you choose whether to use the built-in software CMU or a hardware CMU that you have connected to your DaVinci Resolve workstation.

**NOTE**: Dolby Vision controls are available to all DaVinci Resolve users for monitoring and automatically generating Dolby Vision metadata for creating other HDR and SDR deliverables from the HDR grade you’ve made. However, if you want to be able to make manual trims on top of this automatic analysis, you must email dolbyvisionmastering@dolby.com for more information on obtaining a license.
HDR10+

DaVinci Resolve supports the new HDR10+ HDR format by Samsung. Please note that this support is a work in progress as this is a new standard. When enabled, an HDR10+ palette exposes trimming parameters that let you trim an automated downconversion of HDR to SDR, creating metadata to control how HDR-strength highlights look on a variety of supported televisions and displays. This is enabled and set up in the Color Management panel of the Project Settings with the Enable HDR10+ checkbox. Turning HDR10+ on enables the Dolby Vision palette in the Color page.

Lookup Tables

This group of controls lets you add LUTs to the Resolve image processing pipeline that affect every timeline in the entire project all at once. These LUTs can be used for a wide variety of functions, such as to trim Timeline grades, apply Log to Linear conversions, simulate film output, and limit the signal to accommodate Broadcast Safe requirements. Different options let you insert image processing to different stages of the pipeline as seen in the following diagram:

Keep in mind that since you can apply both 1D and 3D LUTs simultaneously, 1D LUTs at each step are always applied before 3D LUTs.

- **Input Lookup Table:** Two drop-down menus let you add 1D and/or 3D LUTs that process the current Timeline before every other image processing operation in DaVinci Resolve.

- **Output Lookup Table:** Two drop-down menus let you add 1D and/or 3D LUTs that process the current Timeline after the operations applied in the Color page, but before the temporarily applied Display LUT.

- **Video Monitor Lookup Table:** Two drop-down menus let you add 1D and/or 3D LUTs that process the current Timeline after every other image processing operation in DaVinci Resolve. However, Display LUTs are only temporarily applied for purposes of monitoring; they’re never applied to rendered media, or to the signal that is output to tape using the controls in the Deliver page. Display LUTs are particularly valuable for applying a film print emulation LUT in a Log workflow, or for applying a monitor calibration LUT if you’re outputting to a single display and you don’t have dedicated outboard calibration hardware.

Here’s an example. It’s common, when grading for film output using a Log workflow, that you’ll use the Display LUT drop-down menu to apply a film emulation LUT that simulates the image as it will be output from the film recorder, taking into account the film lab and print stock used, in order to make sure that the image you’re grading will appear as close as possible to what the eventual release print will look like in the cinema.
– **Color Viewer Lookup Table:** Two drop-down menus let you add 1D and/or 3D LUTs that process the image shown in the Viewer on your computer display, independently of the Display LUT that’s used to output to your broadcast display. By default, this follows the Video Monitor LUT setting, but you can also use this option to apply a specific calibration transform for your computer monitor. Alternately, you could use it to desaturate the GUI Viewer to be able to specifically evaluate image contrast, or if you don’t want to have to argue with your client over which display looks correct.

– **Scopes Lookup Table:** Ordinarily, DaVinci Resolve’s internal software video scopes provide an unbiased analysis of the actual video data levels within the Resolve image processing pipeline. However, you can choose to have the software scopes use the Video Monitor LUT selection, or any other LUT installed on your system, to transform this analysis to reflect the monitored output.

– **3D Lookup Table Interpolation:** Lets you choose the processing quality of both LUT and DCTL operations in DaVinci Resolve. 3D Lookup tables (LUTs) are 3D tables of red, green, and blue values that specify an output color value for each input color value, thereby providing a method of making color transformations using pre-calculated data. While powerful, 3D LUTs have finite detail; for example, one might have a 17x17x17 LUT that specifies 4913 individual color transforms. When applied to a floating point image that contains more data than the LUT specifies transforms for, color values falling between the 17x17x17 color transforms specified by the LUT need to be interpolated. You can choose from two methods that trade off processing efficiency for higher quality:

  – **Trilinear:** (Default) Trilinear is backward compatible with grades that use LUTs from previous versions of DaVinci Resolve and matches the look of LUTs being applied in other applications.

  – **Tetrahedral:** Tetrahedral is slightly more processor-intensive, but results in higher image quality LUT and DCTL processing, with reduced color-banding. Tetrahedral is recommended for projects that don’t need backward compatibility with previous versions of DaVinci Resolve or LUTs created in other applications.

– **Update Lists button:** Refreshes the LUT drop-down menus if you’ve added new LUTs to your system since DaVinci Resolve has been opened.

– **Open LUT Folder button:** This selection opens the master folder in your file system, as described in the list of DaVinci Resolve LUT paths shown above.

### Adding Lookup Tables to Your DaVinci Resolve Installation

The drop-down menus in the Color Management panel include a series of factory preset LUTs that were installed with DaVinci Resolve, along with any LUTs that have been generated by DaVinci Resolve, or that you’ve imported into the proper directory for your operating system.

**On macOS:** Library/Application Support/Blackmagic Design/DaVinci Resolve/LUT/

**On Windows:** C:\ProgramData\Blackmagic Design\DaVinci Resolve\Support\LUT

**On Linux:** /opt/resolve/LUT

If you downloaded the non-studio version of DaVinci Resolve from the Apple App Store, LUTs are saved in a different location in order for DaVinci Resolve to remain totally self-contained. In this case, you can click the “Open LUT Folder” button in the Lookup Tables panel of the Project Settings, to open up a Finder window at the location these LUTs are stored. You can use this window to copy LUTs that you want Resolve to have access to, or delete LUTs that you no longer need.

If you add a LUT to one of these directories after DaVinci Resolve has been opened, you can click the Update Lists button to refresh the contents of the drop-down menus.

DaVinci Resolve uses both 1D and 3D LUTs. 3D LUTs that are created by DaVinci Resolve are in the .cube format, configured as 33x33x33 cubes with 32-bit floating point processing. DaVinci Resolve can also read and use LUTs in the Shaperlut format.
Broadcast Safe

Broadcast Safe settings can be enabled while you grade to limit both the luma and chroma of the video signal to one of three levels of acceptable overshoots and undershoots.

- **Broadcast safe IRE (mV) levels**: A drop-down menu for choosing one of three levels of aggressiveness when limiting the signal. Choose the range that corresponds to your QC requirements.
- **Make Broadcast Safe**: A checkbox that turns broadcast safe limiting on and off.

**NOTE**: The clipping imposed by Broadcast Safe itself does not have an inherently soft roll-off. For best results, Broadcast Safe should be used in conjunction with the Soft Clip controls in the Color page.

General Options

This panel presents a selection of general preferences that affect the interface and operation of DaVinci Resolve.

Conform Options

The settings in this group determine how clips are conformed to match imported project files with source media on disk by extracting timecode, reel names, file names, file paths, and so on. For more information on conforming and relinking, see Chapter 57, “Conforming and Relinking Clips.”

- **Use Timecode**: Determines how DaVinci Resolve extracts timecode from referenced media files. There are two options:
  - **Embedded in the source clip**: The preferred setting for most projects to conform automatically and apply grades to the resulting clips. As long as DaVinci Resolve can reference the timecode in either a media file’s timecode track, or in the header metadata of the frames in a DPX sequence, you can use timecode to reconform clips, or even completely change the media file to which a clip refers.
  - **From the source clip frame count**: This setting is useful if the source media lacks timecode metadata, and all that’s available is a frame count that identifies frames via sequentially numbered integer values.
- **Conform partial clips with black gaps**: Inserts black frames whenever you conform a clip that doesn’t contain all the required frames. When this option is selected, partial clips are flagged in the Edit page with a P in the thumbnail of the clip that it is lacking frames.
- **Automatically conform missing clips added to Media Pool**: Enabled by default, must be disabled to use collaborative workflow. When this checkbox is turned on, DaVinci Resolve maintains a dynamic relationship between clips in the Media Pool and those in a project’s various timelines. When this checkbox is on and you import clips with matching timecode/file names/reel names to clips in a timeline, DaVinci Resolve will automatically reconform all matching missing clips, and all other timeline clips that have force conform turned off.
- **Assist using reel names from the**: When this checkbox is turned on, DaVinci Resolve uses reel numbers when conforming clips to match any imported project. This setting must also be turned on if you want to choose different reel name extraction methods for individually selected clips using the Clip Attributes window. Turning this checkbox off forces DaVinci Resolve to identify clips using file names when conforming XML and AAF projects. File names can only be used for conforming XML or AAF files, or when importing a DaVinci Resolve project.
There are four options:

- **Source clip file pathname:** Obtains the reel number by extracting it from each media file’s path. This makes it possible to extract a reel number from all or part of the file name, or from all or part of the name of any folder in the path that encloses that file. This extraction is defined using the Pattern field.

- **Pattern:** A code that defines how a reel number should be extracted from the source clip path name. For more information about creating patterns, see “Using the Pattern Field” in Chapter 57, “Conforming and Relinking Clips.”

- **Media Pool folder name:** The reel number is obtained from the name of the bin in the Media Pool that encloses that clip. This option is often used for stereo projects, deriving the reel number from “Left” and “Right” named directories. It’s also useful for projects that are inheriting new VFX clips on a daily basis.

- **Embedding in source clip file:** Useful for file formats where the reel number is embedded within the media file itself. QuickTime files created by Final Cut Pro, DPX frame files, and CinemaDNG files are all formats that are capable of containing reel number header data.

- **Source clip filename:** If there is no defined reel number, often it’s easy to just use the source clip filename. This is a safe option to use in situations where you want to manually choose different reel name extraction methods for individual clips using the Clip Attributes window.

- **Limit reel name matching to X characters:** For situations where you’ve been provided with media files with extra characters in the reel name that don’t correspond to the names used in the project file you’ve been given, “Limit reel name matching to X characters” lets you omit a specific number of characters from the end of a reel name. This works in conjunction with the following setting.

- **Ignore the first X characters of the reel name:** For situations where you’ve been provided with media files with extra characters in the reel name that don’t correspond to the names used in the project file you’ve been given, “Ignore the first X characters of the reel name” lets you omit a specific number of characters from the beginning of the reel name. Combined with the previous setting, you can trim any reel name to a conformable subset of characters.

- **Extract reel names from EDL comments:** Media file formats such as R3D have reel names, obtained from the file names, that are longer than the eight characters that are allowable in a standard EDL. This option allows DaVinci Resolve to extract reel names from appropriately formatted EDL comments, such as those output from Final Cut Pro 7.

- **Sort timeline using reel number and timecode:** Lets you change the behavior of C mode sorting in the Timeline. With this checkbox turned on (the default), all clips in the Timeline are sorted by reel number first, and then by source timecode. This way, clips with similar timecode from the same reel will appear next to one another in C mode. If you turn this checkbox off, reel number is ignored, and all clips in the Timeline are sorted only by source timecode. This may result in clips from multiple sources being mixed together, but it is useful in specific situations.

- **Mixed frame rate format:** (Only available prior to importing media into a project) This drop-down menu lets you choose the method used to conform mixed frame rates for rendering and playback. Which option you choose dictates the accuracy with which retimed clips in DaVinci Resolve match the same clips that were retimed in other editing applications when you import those timelines into DaVinci Resolve via XML or AAF. This drop-down menu also appears in the Load AAF or XML dialogs.

  - **If you’re editing from scratch in DaVinci Resolve:** You should leave this setting set to “Resolve.”

  - **When importing timelines via XML from Apple software:** Choose the “Final Cut Pro 7” or “Final Cut Pro X” methods of conform.

  - **When importing timelines via XML or AAF from Premiere Pro, Media Composer, Smoke, or other NLEs:** You should choose “Resolve.”
When none is selected: DaVinci Resolve conforms and processes all clips in the Timeline to play at the frame rate that’s selected in the “Timeline frame rate” drop-down menu. For example, 23.98, 29.97, 30, 50, 59.94 and 60 fps clips will all play at 24 fps if that’s what “Timeline frame rate” is set to in the Master Project Settings, and clips will play slower or faster accordingly.

How clips in mixed frame rate timelines are rendered out depends on whether the Render Settings are set to render individual source clips or one single clip. When you render the Timeline as individual source clips, all clips are rendered individually at their original frame rate. If you select “single clip,” all clips are converted to the “Timeline frame rate” frame rate and rendered as a single media file.

Color

These settings affect clip versions and timeline interactions when working in the Color page.

– Automatically label gallery stills using: When enabled, DaVinci Resolve automatically generates labels for all gallery stills you take based on the following controls:

– Naming drop-down: Lets you choose what name to use for new stills. Options include: Clip Name, Clip Version Name, Source Timecode, Timeline Timecode, Timeline Name, Display LUT Name, Custom Label Using Tags (using metadata variables).

– Append still number on export checkbox: When enabled, each new still has an appended still number. Where the number appears depends on the following radio buttons.

– As Suffix/As Prefix buttons: Lets you choose to place still numbers at the end of an auto generated gallery label or at the beginning.

– Luminance mixer defaults to zero: Selecting this option sets the Y channel of the YRGB parameters for all grades to zero. This is required to be able to export a compliant ASC-CDL, and will impact all grades that use the Lum Mix control.

– Use legacy Log grading ranges and curve: DaVinci Resolve 12.5 introduced a modification to the Log grading controls that provides smoother, more pleasing results using the same controls. To maintain backward compatibility with older projects, a “Use legacy Log grading ranges and curve” checkbox in the Color panel of the Project Settings lets you switch your project between the older Log control behavior and the newer one. Older projects that are opened in DaVinci Resolve have this checkbox turned on by default, while new projects have this turned off by default.

– Use S-curve for contrast: On by default, this checkbox sets the contrast control in the Color Wheels palette to apply an “S-curve” to the image, such that the shadows and highlights of a signal will not be clipped when you increase the value. If you would prefer for these contrast adjustments to be made linearly, and for the signal to be allowed to clip when you reach the upper and lower boundaries of the video signal, you can turn this checkbox off.

– Use legacy sizing interactions for windows and effects: DaVinci Resolve 14.1.1 improved how window tracking applies transformations, to correctly handle things like pixel aspect ratio (par). New projects should leave this setting disabled, however older projects should leave this checkbox enabled to ensure tracking and transforms remain applied the way they were before.

– Apply stereoscopic convergence to windows and effects: When enabled, DaVinci Resolve correctly maintains the position of a window that’s been properly placed over each eye as convergence is adjusted in the 3D palette. Enabling this checkbox also enables an additional Convergence parameter in the Window palette that lets you create properly aligned convergence for a window that’s placed onto a stereoscopic 3D clip, as seen in the following screenshot.
The Convergence control in the Transform section of the Window palette appears when you enable “Apply stereoscopic convergence to windows and effects.”

- **Use local version for new clips in timeline:** Automatically sets all new clips that are added to existing timelines, or all clips that are added to new timelines that are imported via AAF, EDL, or XML, to use local grades by default. If you want all clips added to new timelines to use remote grades instead, as with DaVinci Resolve version 9 and earlier, you can turn this checkbox off.

- **Automatically match master timeline with media pool:** If you turn on this option before importing any media into the Media Pool, or importing any timelines that will in turn import media into the Media Pool, you can create projects with a Master Timeline. When enabled, clips are added to and removed from the Master Timeline as they’re added to and removed from the Media Pool, so that the Master Timeline always contains all media in the Media Pool. Once media has been imported into a project, this setting cannot be changed.

- **Save timeline thumbnails with project:** To minimize project size, and maximize the speed of saving and loading projects, you should leave this checkbox unchecked. If you select the checkbox, all of your Timeline thumbnails will be stored inside every project, instead of in the default directory that’s ordinarily dedicated to stills, during both Save and Auto Save operations. This provides a good history of the project but takes much longer to complete and uses more hard disk space.

- **Use BGR pixel order for DPX v2:** Lets you choose a different pixel order for projects using DPX version 2 media.

- **Embed timecode in audio output:** When turned on, directs DaVinci Resolve to output LTC timecode that’s embedded in channel 16 of the SDI stream and channel 2 of the analog audio output from your video interface.

- **Use Timelines Bin:** This option is only available to be changed before you add clips to the Media Pool; after you’ve added clips, it’s no longer available. Turning Use Timelines Bin on creates a dedicated Timelines bin in the Media Pool, at the top of the Bin List. When enabled, the Timelines bin contains all timelines in a project, and you’re prevented from putting timelines into any other bin in the Media Pool. Whenever you create or import a new timeline, it automatically appears in the Timelines bin. You can add subfolders to the Timelines bin for more specific organization.

### Dynamics Profile

Defines the default transition from one dynamic keyframe to the next for keyframed effects in the Color page. By default this transition is linear, with the “Dynamic profile start” and “Dynamic profile end” parameters set to 1. However, if you need to alter the acceleration of the interpolation of values from one dynamic keyframe to the next, then you can change that keyframe’s Dissolve Type in order to “ease” the effect transition you’re creating. The values in these settings correspond to the graph curves found in the Dynamic Attributes dialog when editing keyframes in the Color page. For more information, see “Changing Dynamic Attributes” in Chapter 145, “Keyframing in the Color Page.”
Versions

Ten text fields provide a way for you to designate automatic names for the versions of grades that you select in the Color page. To the right of each text field, a drop-down menu lets you add a name from a handy list of predefined terms that’s been provided. Alternately, you can simply click any field and type your own custom name.

When you change the name of a version in the Color page, the names you define in this list are available from a drop-down menu in the Version Name dialog.

Using the named drop-down when editing the name of a version

Using a predefined list of names for your different versions avoids typos that can later create folder naming issues when you use the “Commercial Workflow” options for rendering your media in the Deliver page.

Camera Raw

This panel contains groups of parameters that correspond to every camera raw media format that’s supported by DaVinci Resolve. Using these parameters in the Camera Raw panel, you can override the original camera metadata that was written at the time of recording, and make simultaneous adjustments to all camera raw clips using the “project” raw settings.

To provide more detail, these settings are covered in detail in a dedicated chapter. For more information, see Chapter 128, “Camera Raw Palette.”

Capture and Playback

All settings in this panel let you define the functionality of capture and playout to tape using device controlled VTRs connected to your Resolve workstation via the connected video capture and output interface. For more information on deck capture, see Chapter 23, “Ingesting from Tape.” For more information on video output to tape, see Chapter 188, “Delivering to Tape.”

Deck Settings

These settings affect both capture and playback when using the tape ingest options of the Media page, or the tape output options of the Deliver page.

Video capture and playback: You can choose the video format (frame size and frame rate) with which to output to tape from this drop-down menu. HD timelines can be downconverted to SD, and SD timelines can be upconverted to HD using the format conversion of your DeckLink card.
– **Use left and right eye SDI:** A checkbox that enables supported video interfaces to ingest and output mixed stereoscopic video when used with supported VTRs, such as HDCAM SR decks with 4:2:2 x 2 mode. (When mixed stereoscopic signals are ingested, each eye is separated into individual left-eye and right-eye image files.) This parameter only appears when your hardware is set up appropriately.

– **Video connection operates as:** Selects between the available signal options: Use 4:4:4 SDI and Enable Single Link. Which options are available depend on which video capture card you are using.

– **Data Levels:** Lets you specify the data range (normally Video or Full) that’s used when ingesting from or outputting to tape. This option switches the data range of the signal output by your video capture card, but only during capture from tape in the Media page, or output to tape in the Deliver page. When capture or output is not currently occurring, your video capture card goes back to using the identically named data range setting in the Master Project Settings pane, which governs how you monitor the signal being output on an external broadcast display or projector.

– **Video bit depth:** Choose the bit depth that corresponds to the capability of your deck. Depending on your workstation’s configuration, you can choose between 8-bit and 10-bit. Outputting to 10-bit is more processor intensive, but higher quality for compatible devices, and is the default setting.

– **Use deck autoedit:** If supported by your video deck, this is the best method to record video to the deck, as it enables the deck to roll the edit using the specified preroll, and control the edits via serial device control. If this checkbox is turned off, a basic edit On/Off mode is used by the deck, with the potential for frame inaccuracies if the “Non auto edit timing” setting is not properly adjusted.

– **Non auto edit timing:** Adjusts the edit synchronization of the connected deck when auto edit is turned off.

– **Deck preroll:** Sets the number of seconds for preroll. How much is appropriate depends on the performance of your deck.

– **Video output sync source:** When using a DeckLink card this is set to Auto. Other capture cards may require you to set the sync source to “Reference” for playout and “Input” for ingest. This setting is only available if you have a DVS card installed on your system.

– **Add 3:2 pulldown:** Inserts or removes the 3:2 pulldown required to record or play 23.98 fps media to or from a 29.97 tape format.

### Capture

These settings are used when you use the Capture mode in the Media page to capture clips from tape into the Media Pool.

– **Capture:** Lets you choose whether to capture both Video and Audio, or Video Only.

– **Video Format:** The format that scanned film frames are saved as. When capturing from tape, the available options are DPX and QuickTime. When capturing from the Cintel film scanner, this is restricted to Cintel Raw Image (CRI), which is a raw data format that DaVinci Resolve automatically debayers as a Cineon log-encoded image for grading.

– **Codec:** The codec used to write captured media. When capturing from tape, these include the various type of Apple ProRes, 8- and 10-bit YUV 422, 10-bit RGB, and the various types of DNxHD. Cintel Raw Image files default to rgb.

– **Save clips to:** A field that displays the directory path to which media files captured from tape are written. You want to choose a volume that’s fast enough to accommodate the data rate of the media format you’re capturing.

– **Browse:** Click this button to choose a directory to write captured media to. The directory you choose appears in the field above.
– **Save in this folder path:** A series of checkboxes let you specify what other information to use to define the directory hierarchy that will hold the captured media. Every checkbox you turn on adds an additional directory with a name defined by that checkbox’s metadata. You can choose any or all of the following: Program name, Clip number, Reel number, and Roll/Card.

– **Apply reel number to:** Lets you choose how to write the reel name. Two checkboxes let you write the reel number to the file’s name, and/or to the Header data.

– **Use prefix:** A field lets you type in a prefix to be used in the media file’s name. This lets you add text identification that will make the media more easily identifiable and searchable.

– **Apply prefix to:** Two checkboxes let you choose to use the prefix you typed in the file name, and/or in the folder name.

– **Use frame number with:** When capturing to image sequences, you can choose how many digits to use when writing the frame number into the name of each frame file.

– **Set batch ingest handles to:** When capturing to image sequences from a batch list, defines how many frames of additional handles to ingest along with each logged clip.

– **Input:** Lets you choose how many tracks of audio to capture, from 2 to 16.

## Playout

These settings only affect the video signal that’s output when you use the Edit to Tape mode of the Deliver page.

– **Output:** Lets you choose whether to output both Video and Audio, Video Only, or Audio Only if you’re doing an audio layback.

– **Output Source Timecode:** Turn this checkbox on to output each individual clip’s source timecode. This option is only applicable when assemble editing to tape.

– **Output LTC:** With a Blackmagic Design DeckLink or UltraStudio device using HD-SDI, longitudinal timecode (LTC) is available on track 16 of the HD-SDI video signal, making it easy to use a Mini Converter de-embedder to extract this analog timecode audio signal and feed it directly to a recording device. This is particularly helpful if you have outboard video processing equipment such as a noise reducer or format converter that passes through the VITC timecode.

– **Delay LTC by x frames:** When outputting LTC to bypass outboard processing gear, such as a noise reducer or format converter, you can compensate for the processing delay by delaying the timecode by a matter of frames to ensure that the processed image and timecode reach the deck at the same time. With a DVS card there is a separate timecode output.

– **Offset audio by x frames:** Lets you specify an offset between the audio track and video to achieve proper A/V sync in cases where the video is being delayed by outboard processing hardware.

– **Output x channels of audio:** Choose the number of audio tracks to output to tape.

– **Set batch playout head handle to x seconds:** When batch outputting multiple clips, you can specify a number of frames before the In point of each clip to be output as well.

– **Set batch playout tail handle to x seconds:** When batch outputting multiple clips, you can specify a number of frames after the Out point of each clip to be output as well.
Subtitles

The Subtitles panel lets you adjust presets that govern subtitles being created in subtitle tracks of the timeline.

- **Max Character Per Line**: Defaults to 60. Lets you choose the maximum number of characters allowed on one line in a subtitle.
- **Minimum Caption Duration**: Defaults to 3 seconds. Lets you choose the minimum duration allowed for subtitles in the timeline.
- **Maximum Characters Per Second**: Defaults to 30. Automatically calculates the maximum allowable characters per second based on a subtitle clip's duration.

Fairlight

The Fairlight panel lets you set up your project’s audio sample rate, as well as setting up various audio-specific tools in the Fairlight page.

**Timeline Sample Rate**

This setting can only be changed prior to creation of your first timeline. Once one or more timelines have been created in a project, the Audio Sample Rate is locked to whatever was chosen.

The Audio Sample Rate, measured in kilohertz, is the number of samples per second used for audio processing in DaVinci Resolve. This setting defaults to 48000 (or 48 kHz), which is typical for broadcast and cinema work. However, you can change this to 96000 or 192000 if you want to mix and process audio at higher precision. Be aware that using a higher sample rate, such as 96 kHz instead of 48 kHz, will use twice as much processing power and result in media that’s twice the size.

**NOTE**: Regardless of the Timeline Sample Rate you select, when you import audio files at different sample rates, they will be automatically re-sampled to the Timeline Sample Rate so they play correctly.

Audio Metering

Two options in the General Options of the Project Settings let you customize the Loudness Meters on the Fairlight page, while the others affect all other audio meters in DaVinci Resolve.

- **Target Loudness Level**: Lets you set the LUFS value that’s used as a reference level for loudness metering. Defaults to –23 LUFS, which conveniently makes the display of these meters scale similarly to traditional audio meters that you’re already used to.
- **Loudness Scale**: Lets you choose which scale you want to use with which to measure the meters. Options currently include the default of EBU +9 Scale (–18 to +9), and EBU +18 Scale (–36 to +18).
- **Bus Meter Alignment Level**: Sets the peak of the bus meter.
- **Bus Meter High Level**: Sets the dB level at which the meter starts showing red.
- **Bus Meter Low Level**: Sets the dB level at which the meter starts showing yellow.
– **Track Meters:** Lets you choose how meters in the Fairlight page display their audio analysis. There are two options:

– **Post Fader:** Meters always display the level of each clip’s signal after whatever fader adjustments have taken place. Fading a track’s level down diminishes the visible level of that audio signal in the meter. This setting is good if you prefer a visual indication of the relative levels you’ve set your various audio tracks to, which is a very NLE-oriented behavior.

– **Track Source:** Meters always use the volume levels of the audio clips in that track, even if you’ve lowered the level using the sliders. If you’ve keyframed a clip’s volume, that change will be reflected by the audio meters, even though fader changes are not. Viewing meters this way means you can always see how much level is available to clips in your mix regardless of what the current fader levels are set to, in the event you want to keep track of audio you want to bring back into the mix later on. This is a very DAW-oriented behavior.

**Immersive Audio**

You can enable these audio surround formats in the Fairlight panel of the Project Settings. Once enabled, all supported channel configurations of each format become available for timeline track mappings, clip attributes channel mappings, Fairlight bus mappings, and output settings.

For more information, see Chapter 180, "Immersive Audio Workflows."
Chapter 6

Camera Raw Settings

This chapter discusses in detail each of the settings available for every camera raw format that is supported in DaVinci Resolve. These settings are available in the Camera Raw panel of the Project Settings, via a contextual menu command in the Media Pool that exposes a floating window, or in the Camera Raw palette of the Color page.

Contents

Camera Raw Decoding Explained 135
Camera Raw Project Settings 135
Camera Raw Image Inspector 136
ARRI ALEXA 137
Master Settings 137
Project Settings 137
Use Camera Metadata 138
Blackmagic RAW 139
BRAW Sidecar Metadata Files 139
Master Settings 139
Project Settings 139
Use Camera Metadata 141
Canon RAW 142
Master Settings 142
Project Settings 142
Use Camera Metadata 143
CinemaDNG 143
Master Settings 144
Project Settings 144
Use Camera Metadata 146
Panasonic Varicam RAW 146
Master Settings 146
Project Settings 147
Use Camera Metadata 147
Phantom Cine 148
Master Settings 148
Project Settings 148
RED 149
Master RED Settings 149
Master 149
Project Settings 150
Decoder Settings 153
Use Camera Metadata 154
Sony RAW 154
Master Settings 154
Project Settings 155
Use Camera Metadata 156
Camera Raw Decoding Explained

Camera raw media formats are so named because they capture raw color space data directly from the sensor of whatever digital cinema camera did the recording. Raw image data is not human readable, and must be debayered or demosaiced to convert the original raw data into image data that can be handed off to DaVinci Resolve’s image processing pipeline.

Raw decoding is the very first image processing operation that takes place, and it takes place before all other operations in the Color page, before even the Source bar in the Node Editor. For this reason, it’s important to understand that the ideal transformation of raw image data to DaVinci Resolve-friendly image data is one that preserves the maximum amount of image data for continued processing. Since the 32-bit floating point accuracy of DaVinci Resolve’s image processing pipeline preserves all transformed raw data with exceptional fidelity, the Camera Raw parameters are primarily useful for making whatever initial adjustments will produce the most optimum starting point for grading.

Each group of Camera Raw settings is available from the Raw Profile menu. This description covers the settings that are available for each of the camera raw media formats supported by DaVinci Resolve.

Camera Raw Project Settings

The Camera Raw panel of the Project Settings contain groups of parameters that correspond to every camera raw media format that’s supported by DaVinci Resolve. Using these parameters in the Camera Raw panel, you can override the original camera metadata that was written at the time of recording, and make simultaneous adjustments to all camera raw media throughout your project.

![Camera Raw project settings](image-url)
Each supported camera format has different controls that are specific to that format. These controls are also mirrored in the Camera Raw palette in the Color page, which lets you individually adjust the Camera Raw parameters for individual clips in a Timeline when you set Decode Using to Clip.

Camera Raw project palette in the Color page

**Camera Raw Image Inspector**

The Image panel in the Inspector exposes the Camera Raw parameters. If the video clip is in a Raw format, the specific camera’s Raw controls will be exposed for user manipulation. Raw still images from Nikon (NEF) and Canon (CR2) cameras can also be adjusted in this panel.

The Image Inspector for a Blackmagic RAW file
ARRI ALEXA

The ARRI ALEXA can record ProRes, DNxHD, or raw image data. When shooting raw, image data is recorded straight from the Bayer sensor, and must be debayered by DaVinci Resolve.

Master Settings

ARRI ALEXA media is extremely simple to debayer. There are only three Master settings.

– **Decode Quality:** Lets you debayer ARRI ALEXA raw files at Full, Half, or Quarter resolution to improve performance on slower systems. Lower resolution media is lower quality, but faster to work with and process. If necessary, you can choose a lower resolution setting that provides better real time playback on systems with limited performance while you work, and then switch to a higher quality when rendering the final output. A “Force debayer res to highest quality” checkbox in the Render Settings list of the Deliver page makes it easy to follow this workflow.

– **Decode Using:** The option you select determines whether all ARRI ALEXA media throughout the project is decoded using the original Camera Metadata settings (the default selection), using Project settings in which you choose custom settings to be applied to all clips, or using the ARRI default settings.

– **Import Media at Open Gate Resolution:** Enables DaVinci Resolve to access the “open gate” area of clips from ALEXA cameras capable of shooting in this mode, which produces a 3.4K image with extra area for stabilization and repositioning.

Project Settings

The following decoder settings let you adjust the color and exposure of ALEXA clips.

– **Lift:** Adjusts the black point of the media, raising it or lowering it while scaling all midtone values between it and the white point. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. The range is –100 to +100.

– **Gain:** Adjusts the white point of the media, raising or lowering it while scaling all midtone values between it and the black point. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

– **Contrast:** Raising contrast reduces shadows and raises highlights, while leaving midtones at 50 percent unaffected. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

– **Tint:** Adjusts color balance to push the image between magenta and green; useful for balancing images with a green or magenta color cast, such as fluorescent or sodium vapor bulbs. 0 is unity. The range is –150 to +150.

– **Sharpness:** A debayer-specific sharpness filter applied to provide the appearance of enhanced image detail. 0 is unity, and 10 is the default. The range is 0 to 100.

– **Highlights:** Makes it easy to selectively retrieve blown-out highlight detail in high-dynamic-range media by lowering this parameter, and achieves a smooth blend between the retrieved highlights and the unadjusted midtones for a naturalistic result. 0 is unity. The range is –100 (minimum) through +100 (maximum).

– **Shadows:** Lets you selectively lighten or darken shadow detail. Raising this value retrieves shadow detail recorded below 0 percent, while leaving the midtones alone. 0 is unity. The range is –100 (minimum) through +100 (very high).

– **Color Boost:** Lets you naturalistically raise the saturation of regions of low saturation, sometimes referred to as a vibrance operation. Can be used also to lower the saturation of regions of low saturation. 0 is unity. The range is –100 (minimum) through +100 (very high).
– **Saturation**: Adjusts the color intensity of the image. 0 is unity. The range is –100 (minimum) through +100 (very high).

– **Midtone Detail**: When this parameter is raised, the contrast of regions of the image with high edge detail is raised to increase the perception of image sharpness, sometimes referred to as definition. When this parameter is lowered to a negative value, regions of the image with low amounts of detail are softened while areas of high detail are left alone. 0 is unity. The range is –100 (minimum) through +100 (very high).

### Use Camera Metadata

The most elemental camera metadata settings for exposure and color that are available.

– **Color Temp**: Adjusts color balance to alter the “warmth” of the image. Adjustable in Kelvin. Lower values correct for “warmer” lighting, while higher values correct for “cool” lighting. +2000 is unity. The range is +2000 to +11,000.

– **Tint**: Only available when White Balance is set to something other than As Shot. Designed to alter the green to magenta balance of the image, for images with fluorescent tinting. Lower values add green to compensate for magenta lighting, while higher values add magenta to compensate for green lighting. 0 is unity. The range is –12 to +12.

– **Exposure**: Increases or lowers image lightness in units relative to ASA values. If your intended exposure adjustment lifts image data above the maximum white level, don’t worry; all image data is preserved and can be retrieved in subsequent adjustments. 160 is unity. The range is +160 to +3200.

– **Finetune Red**: Advanced debayer setting.

– **Finetune Green**: Advanced debayer setting.

– **Finetune Blue**: Advanced debayer setting.

### ARRI Media and Log-C

ALEXA media is usually recorded using Log-C gamma and color processing, which is very similar to the Cineon Log gamma curve, developed by Kodak to produce flat-contrast, wide-gamut image data that preserves image detail with a wide latitude for adjustment. There is no ALEXA raw parameter to adjust this, so for Rec. 709 monitoring and deliverables you need to “normalize” Log-C clips in one of three ways.

You can use Resolve Color Management (RCM) to automatically normalize log-encoded media according to the type of media it is.

You can create your own adjustment to normalize Log-C clips as part of the grading process, using the parameters of the Color page. This approach gives you the most flexibility, as you’ll be making custom settings that maximize the image data that’s available in every scene.

Alternately, you can use a LUT to normalize Log-C clips to obtain a fast starting point for additional grading. Used in this way, LUTs can be applied either as an output LUT, if the entire Timeline is nothing but ALEXA raw media, or as a LUT that’s applied to an individual node of a grade, if you’re mixing ALEXA raw media with other formats. This provides a fast and easy solution to linearizing ALEXA media that can be useful for creating dailies for offline editing. However, one LUT may not be suitable for all clips. If you’re applying individual LUTs to each clip, you can create multiple LUTs, each with differing contrast settings, in order to gain the speed benefits of using LUTs, while taking into account the individual differences among clips.

ARRI has a LUT generator available online that you can use to create custom LUTs for use with a variety of color correction applications at: [www.arri.com/camera/alexa/tools/lut_generator.html](http://www.arri.com/camera/alexa/tools/lut_generator.html)
Blackmagic RAW

A raw format developed by Blackmagic Design and used by a variety of Blackmagic cameras. This format relies on the increased processing capabilities of modern cameras to perform a certain amount of in-camera pre-processing (including noise management, sensor profiling, and edge reconstruction) to partially de-mosaic the image and then re-encode the result, factoring in the characteristics of the originating image sensor. The image is encoded in such a way as to later enable typical raw controls but with efficiently compressed files (using a custom non-linear 12-bit space) that are not computationally challenging to decode and use. BRAW media can be encoded at either a Constant Bitrate (with variable compression of 3:1, 5:1, 8:1, and 12:1) or at Constant Quality (with a variable bitrate).

BRAW Sidecar Metadata Files

BRAW files have been designed to accommodate descriptive metadata that enables look management from on-set through post. This metadata is both embedded in the .braw files and included within .sidecar files that are saved alongside the media. Metadata .sidecar files that are present always takes precedence over the embedded metadata for purposes of decoding. However, if there’s no .sidecar file, decoding of the .braw file falls back on the embedded metadata.

Modifying Sidecar Files

You can use the Camera Raw palette of the Color page to Update a BRAW clip’s sidecar file with changes made to the Camera Raw settings. Click Update Sidecar to save changes, and click Export Frame to export a one-frame image for reference.

Master Settings

These parameters let you choose the decode quality and method that raw clips will be transformed to use when debayered.

– Decode Quality: Lets you debayer .braw files at Full, Half, Quarter, or Eighth resolution to improve performance on slower systems. Lower resolution media is lower quality but faster to work with and process. If necessary, you can choose a lower resolution setting that provides better real time playback on systems with limited performance while you work, and then switch to a higher quality when rendering the final output. A “Force debayer res to highest quality” checkbox in the Render Settings list of the Deliver page makes it easy to follow this workflow.

– Decode Using: The option you select determines whether all .braw media throughout the project is decoded using the original Camera Metadata settings (the default selection), using Project settings in which you choose custom settings to be applied to all clips, or using the Blackmagic Raw default settings.

Project Settings

These parameters let you choose the color science, white balance color space, gamma, and other visual settings guiding how the image will be transformed to suit your program and RCM.

– Color Science: Lets you choose what version of camera color science you want to use to decode .braw media.

– Camera Metadata: Chooses whichever version of color science was selected by the camera at the time of shooting.

– Gen 4: The original version of color science available for recording and decoding .braw media.

– Gen 5: A newer more film-like curve designed for better skin tones and high contrast/saturation color response.
– **White Balance**: The first seven options offer White Balance presets, which automatically adjust the Color Temp and Tint parameters. These options include: Daylight, Cloudy, Shade, Tungsten, Fluorescent, and Flash. An eighth option, Custom, makes the Color Temp and Tint parameters user-adjustable. The default is As Shot.

– **Color Space**: Debayering .braw data requires choosing a color space to convert the raw signal into. Bear in mind that the color space you choose is merely a starting point for further correction. There is no requirement that you choose one or the other color space for any given workflow, and all settings will yield high-quality image data suitable for further color correction. You should choose the color space that provides the most pleasing starting point for your particular project.

  – **Blackmagic Design**: A wide gamut color space designed for digital cinema workflows on Blackmagic Design cameras.
  
  – **Rec. 709**: Decodes into the standard color space specified by the Rec. 709 standard for high definition video. While you may find this option useful as a starting point, it is not required for programs being output to video.
  
  – **Rec. 2020**: Decodes into the standard color space specified by the Rec. 2020 standard for high definition video, UHD video, and beyond. While you may find this option useful as a starting point, it is not required for programs being output to video.
  
  – **DCI-P3 D65**: Decodes RGB-encoded image data with a D65 white point, intended for monitoring with a P3-compatible display.
  
  – **DCI-P3 Theater**: A setting designed for adaptive viewing of DCI-P3 in a theater with a projector using a D60 white point.
  
  – **CIE 1931 XYZ D65**: A specialty setting for outputting to an XYZ color space with a D65 adaptive white point.
  
  – **CIE 1931 XYZ D50 (PCS)**: A specialty setting for outputting to an XYZ color space with a D50 adaptive white point, as used by the profile connection space of the DNG image format.

– **Gamma**: There are several options available for choosing a gamma profile to be used when debayering .braw media. Which one is best really depends on how you like to work, as all will yield high-quality image data without clipping the signal internally within DaVinci Resolve’s image processing pipeline. Even though some of these options will produce a range of image data that will clip on output, all of that image data is preserved “under the hood” and can be used and retrieved in your grade.

  – **Blackmagic Design Film**: A log-encoded “film workflow” oriented option that’s specifically designed for version 4 of the Blackmagic Design color science. This option is designed to fit the maximum amount of information from wide latitude BMD cameras into the data range of 0–1023. Using this setting provides all the dynamic range from the source media into a signal that can be transcoded to other formats with no compromise. However, this is not a viewable image and requires grading to normalize it into an image that can be delivered to audiences.
  
  – **Blackmagic Design Video**: The standardized gamma curve for standard-dynamic-range HD and UHD display. For wide-latitude images, highlights will be clipped, but all image data will be preserved internally for retrieval via grading as necessary.
  
  – **Blackmagic Design Extended Video**: An SDR-compatible gamma curve similar to the above but with compressed highlights that preserve more highlight detail in the visible range of the image. Intended to be a fast starting point for grading SDR images. Fewer highlights are clipped, but nonetheless all image data is preserved internally for retrieval via grading as necessary.
  
  – **Blackmagic Design Custom**: For specialty workflows.
  
  – **Linear**: A scene linear setting, suitable for visual effects and specialty workflows.
– **Rec. 2100 Hybrid Log Gamma**: The standardized gamma curve for the HLG standard of highdynamic-range (HDR) video jointly developed by the BBC and NHK.

– **Rec. 2100 ST2084 (PQ)**: The standardized gamma curve for highdynamic-range (HDR) video as encoded by Dolby Vision and HDR10+. Also referred to as the PQ curve.

– **Highlight Recovery**: A checkbox that lets you include additional highlight sensor data that’s usually clipped by the standard decoding matrix. In cases where you have extremely clipped peak highlights, you may obtain additional image detail this way, although it may contain unusual color artifacts.

– **Gamut compression**: Prevents monochromatic highly saturated light sources (LEDs, neon signs, etc.) from clipping the gamut.

– **Apply LUT**: Applies color metadata to the BRAW file from the selected LUT source.

– **LUT source**: Choose the color metadata from the sidecar file, or the metadata embedded in the clip.

– **Saturation**: Adjusts the color intensity of the image. 1 is unity. The range is 0 (desaturated) through +4 (extremely high).

– **Contrast**: Increases contrast by raising the top of the signal and lowering the bottom of the signal about the Midpoint slider (described below). Raising this value increases contrast, while lowering this value lowers contrast. 1 is unity. The range is 0 (minimum contrast) to +2 (maximum contrast).

– **Midpoint**: The level about which contrast is either expanded or contracted. 0.41 is unity. The range is 0 (black) to +1 (maximum white).

– **Highlight Rolloff**: Makes it easy to selectively retrieve blown-out highlight detail in highdynamicrange media by lowering this parameter and achieves a smooth blend between the retrieved highlights and the unadjusted midtones for a naturalistic result. 1 is unity. The range is 0 (minimum) through +2 (maximum).

– **Shadow Rolloff**: Lets you selectively lighten or darken shadow detail. Raising this value retrieves shadow detail recorded below 0 percent while leaving the midtones alone. 1 is unity. The range is 0 (minimum) through +2 (very high).

– **White Level**: A gain setting for adjusting the highlights.

– **Black Level**: A lift setting for adjusting the shadows.

– **Use Video Black Level**: A legacy video setting that adds pedestal to the video signal. For people using video equipment dating from when shoulder pads were cool.

**Use Camera Metadata**

The most elemental camera metadata settings for exposure and color that are available. Deselect the Use Camera Metadata checkboxes to activate the controls.

– **Exposure**: Increases or lowers image lightness in units relative to f-stops. If your intended exposure adjustment lifts image data above the maximum white level, don’t worry; all image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –5 to +5.

– **Color Temp**: Only available when White Balance is set to something other than As Shot. Designed to alter the “warmth” of the image. Adjustable in Kelvin. Lower values correct for “warmer” lighting, while higher values correct for “cool” lighting. +5500 is unity. The range is +2000 to +50,000.

– **Tint**: Only available when White Balance is set to something other than As Shot. Designed to alter the green to magenta balance of the image, for images with fluorescent tinting. Lower values add green to compensate for magenta lighting, while higher values add magenta to compensate for green lighting. 0 is unity. The range is –150 to +150.
BRAW Files and Blackmagic Design Film

Blackmagic Design’s logarithmically encoded Blackmagic Design Film gamma setting, which produces flat-contrast, wide-gamut image data that preserves image detail with a wide latitude for adjustment, is a modified version of the standard Cineon curve. However, the modifications are designed to emphasize the strengths of the sensors used by the Blackmagic Design cameras. Similarly to working with clips using Cineon, the ARRI ALEXA’s Log-C gamma, or Sony’s proprietary S-Log or S-Log2 formats, you need to normalize clips using Blackmagic Design Film by using Resolve Color Management (RCM), by making a manual adjustment to color and contrast, or by applying a LUT, using techniques discussed previously.

Canon RAW

Canon RAW (CRW) is produced by a variety of Canon cameras.

Master Settings

These parameters let you choose the decode quality and method that raw clips will be transformed to use when debayered.

– **Decode Quality:** Lets you debayer Canon RAW files at Full, Half, or Quarter resolution to improve performance on slower systems. Lower resolution media is lower quality but faster to work with and process. If necessary, you can choose a lower resolution setting that provides better real time playback on systems with limited performance while you work, and then switch to a higher quality when rendering the final output. A “Force debayer res to highest quality” checkbox in the Render Settings list of the Deliver page makes it easy to follow this workflow.

– **Decode Using:** The option you select determines whether all Canon RAW media throughout the project is decoded using the original Camera Metadata settings (the default selection), using Project settings in which you choose custom settings to be applied to all clips, or using the Canon RAW default settings.

Project Settings

Canon RAW has a variety of settings that can be adjusted to alter the image quality of the debayered result. The Color Temp and Tint parameters are only available if the White Balance drop-down menu is set to Custom.

– **White Balance:** The first seven options offer White Balance presets, which automatically adjust the Color Temp and Tint parameters. These options include Daylight, Cloudy, Shade, Tungsten, Fluorescent, and Flash. An eighth option, Custom, makes the Color Temp and Tint parameters user-adjustable.

– **Color Space:** No color spaces are selectable at the time of this writing.

– **Gamma:** No gamma settings are selectable at the time of this writing.

– **Tint:** Color balance correction for images with a green or magenta color cast, such as fluorescent or sodium vapor bulbs. 0 is unity. The range is –150 to +150.

– **Sharpness:** A debayer-specific sharpness filter applied to provide the appearance of enhanced image detail. 20 is unity. The range is 0 to 100.

– **Highlights:** Makes it easy to selectively retrieve blown-out highlight detail in high-dynamic-range media by lowering this parameter and achieves a smooth blend between the retrieved highlights and the unadjusted midtones for a naturalistic result. 0 is unity. The range is –100 (minimum) through +100 (maximum).
– **Shadows**: Lets you selectively lighten or darken shadow detail. Raising this value retrieves shadow detail recorded below 0 percent, while leaving the midtones alone. 0 is unity. The range is –100 (minimum) through +100 (very high).

– **Color Boost**: Lets you naturally raise the saturation of regions of low saturation, sometimes referred to as a vibrance operation. Can be used also to lower the saturation of regions of low saturation. 0 is unity. The range is –100 (minimum) through +100 (very high).

– **Saturation**: Adjusts the color intensity of the image. 0 is unity. The range is –100 (minimum) through +100 (very high).

– **Midtone Detail**: When this parameter is raised, the contrast of regions of the image with high edge detail is raised to increase the perception of image sharpness, sometimes referred to as definition. When this parameter is lowered to a negative value, regions of the image with low amounts of detail are softened while areas of high detail are left alone. 0 is unity. The range is –100 (minimum) through +100 (very high).

– **Lift**: Adjusts the black point of the media, raising it or lowering it while scaling all midtone values between it and the white point. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. The range is –100 to +100.

– **Gain**: Adjusts the white point of the media, raising or lowering it while scaling all midtone values between it and the black point. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

– **Contrast**: Raising contrast reduces shadows and raises highlights, while leaving midtones at 50 percent unaffected. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

### Use Camera Metadata

The most elemental camera metadata settings for exposure and color that are available.

– **Exposure**: Increases or lowers image lightness in units relative to f-stops. If your intended exposure adjustment lifts image data above the maximum white level, don’t worry; all image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –5 to +5.

– **Color Temp**: Only available when White Balance is set to something other than As Shot. Designed to alter the “warmth” of the image. Adjustable in Kelvin. Lower values correct for “warmer” lighting, while higher values correct for “cool” lighting. +6500 is unity. The range is +2000 to +50,000.

– **Tint**: Only available when White Balance is set to something other than As Shot. Designed to alter the green to magenta balance of the image, for images with fluorescent tinting. Lower values add green to compensate for magenta lighting, while higher values add magenta to compensate for green lighting. 0 is unity. The range is –150 to +150.

### CinemaDNG

CinemaDNG is an open format capable of high-resolution raw image data with a wide dynamic range and is one of the formats recorded by the Blackmagic Design Camera when you shoot in raw mode. CinemaDNG images are decoded with full dynamic range when the Highlight Recovery checkbox is selected.

DaVinci Resolve version 11.2.1 introduced improved debayering for raw CinemaDNG media acquired using any of the Blackmagic Design cameras. The “Apply Pre Tone Curve” setting controls whether you’re using the older debayering method (when turned on) or the newer, visually improved debayering method (when turned off).
**Master Settings**

These parameters let you choose the decode quality, white balance, color space, and gamma that raw CinemaDNG clips will be transformed to use when debayered.

- **Decode Quality:** Lets you debayer CinemaDNG raw files at Full, Half, or Quarter resolution to improve performance on slower systems. Lower resolution media is lower quality but faster to work with and process. If necessary, you can choose a lower resolution setting that provides better real time playback on systems with limited performance while you work, and then switch to a higher quality when rendering the final output. A “Force debayer res to highest quality” checkbox in the Render Settings list of the Deliver page makes it easy to follow this workflow.

- **Decode Using:** The option you select determines whether all CinemaDNG media throughout the project is decoded using the original Camera Metadata settings (the default selection), using Project settings in which you choose custom settings to be applied to all clips, or using the CinemaDNG default settings.

- **Apply Pre Tone Curve:** When this checkbox is turned off (the default for new projects created in DaVinci Resolve 11.2.1 or later), DaVinci Resolve debayers CinemaDNG raw media using an improved method that delivers better-looking results, specifically for media acquired using any of the Blackmagic Design cameras. When this checkbox is turned on (the default for projects created in earlier versions of DaVinci Resolve), the older debayering method is reenabled for backward compatibility. However, turning Pre Tone Curve on may also provide better results for CinemaDNG raw files coming from other sources. If you’re importing .dng media from cameras other than those from Blackmagic Design, you should try both settings to see which type of debayering you prefer.

- **Apply Soft Clip:** This checkbox is only available when Apply Pre Tone Curve is turned off. When turned on, high dynamic range parts of the signal (super-white highlights) are brought back into the picture as visible image detail you can adjust, similar to using the Highlights control to retrieve these otherwise clipped parts of the signal.

**Project Settings**

CinemaDNG has a variety of settings that can be adjusted to alter the image quality of the debayered result. The Color Temp and Tint parameters are only available if the White Balance drop-down menu is set to Custom.

- **Color Science:** Lets you choose what version of camera color science you want to use to decode CinemaDNG media.
  - **Camera Metadata:** Chooses whichever version of color science was selected by the camera at the time of shooting.
  - **Gen 4:** The original version of color science available for recording and decoding CinemaDNG media.

- **White Balance:** The first seven options offer White Balance presets, which automatically adjust the Color Temp and Tint parameters. These options include: Daylight, Cloudy, Shade, Tungsten, Fluorescent, and Flash. An eighth option, Custom, makes the Color Temp and Tint parameters user-adjustable.

- **Color Space:** Multiple color spaces are adjustable, depending on your intended workflow:
  - **Rec. 709:** Decodes into the standard color space specified by the Rec. 709 standard for high definition video.
  - **P3 D60:** Decodes into the standard P3 color space specified by the DCI standard for digital cinema projection.
– **Blackmagic Design**: Decodes into a log-encoded color space that remaps the raw data into an approximation of the Log-C standard. Choosing Blackmagic Design Film also forces the Gamma setting to Blackmagic Design Film. This setting produces flat-contrast image data that preserves image detail with a wide latitude for adjustment, which is suitable as a starting point for detailed grading and is also compatible with log workflows intended for film output.

– **Gamma**: Five gamma settings are available, depending on what starting point you want to use for further grading.
  - **2.4**: A simple power-function gamma setting commonly used for broadcast.
  - **2.6**: A simple power-function gamma setting commonly used for digital cinema projection.
  - **Rec. 709**: A gamma of 2.35, with a linear segment near black, approximating the EBU recommended gamma for broadcast.
  - **sRGB**: A gamma of 2.2, with a linear segment near black, intended for reproduction on computer displays alongside the sRGB color space.
  - **Linear**: A simple linear gamma setting.
  - **Blackmagic Design Film**: A log-encoded gamma setting that approximates Cineon encoding, the main difference being that more data is encoded in the darkest portion of the Blackmagic Design Film signal. When you choose this setting, the appropriate variation of gamma will be applied based on your particular sensor, be it 4K or 4.6K.
  - **Blackmagic Design Video**: A normalized gamma setting that provides a fast starting point for grading if you don’t want to begin with a log-encoded image.

– **Highlight Recovery**: A checkbox that lets you include additional highlight sensor data that’s usually clipped by the standard decoding matrix. In cases where you have extremely clipped highlights, you may obtain additional image detail this way, although it may contain unusual color artifacts.

– **Sharpness**: A debayer-specific sharpness filter applied to provide the appearance of enhanced image detail. 20 is unity. The range is 0 to 100.

– **Highlights**: Makes it easy to selectively retrieve blown-out highlight detail in high-dynamic-range media by lowering this parameter and achieves a smooth blend between the retrieved highlights and the unadjusted midtones for a naturalistic result. 0 is unity. The range is –100 (minimum) through +100 (maximum).

– **Shadows**: Lets you selectively lighten or darken shadow detail. Raising this value retrieves shadow detail recorded below 0 percent, while leaving the midtones alone. 0 is unity. The range is –100 (minimum) through +100 (very high).

– **Color Boost**: Lets you naturalistically raise the saturation of regions of low saturation, sometimes referred to as a vibrance operation. Can be used also to lower the saturation of regions of low saturation. 0 is unity. The range is –100 (minimum) through +100 (very high).

– **Saturation**: Adjusts the color intensity of the image. 0 is unity. The range is –100 (minimum) through +100 (very high).

– **Midtone Detail**: When this parameter is raised, the contrast of regions of the image with high edge detail is raised to increase the perception of image sharpness, sometimes referred to as definition. When this parameter is lowered to a negative value, regions of the image with low amounts of detail are softened while areas of high-detail are left alone. 0 is unity. The range is –100 (minimum) through +100 (very high).

– **Lift**: Adjusts the black point of the media, raising it or lowering it while scaling all midtone values between it and the white point. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. The range is –100 to +100.
– **Gain:** Adjusts the white point of the media, raising or lowering it while scaling all midtone values between it and the black point. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

– **Contrast:** Raising contrast reduces shadows and raises highlights, while leaving midtones at 50 percent unaffected. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

### Use Camera Metadata

The most elemental camera metadata settings for exposure and color that are available.

– **Exposure:** Increases or lowers image lightness in units relative to f-stops. If your intended exposure adjustment lifts image data above the maximum white level, don't worry; all image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –5 to +5.

– **Color Temp:** Only available when White Balance is set to something other than As Shot. Designed to alter the “warmth” of the image. Adjustable in Kelvin. Lower values correct for “warmer” lighting, while higher values correct for “cool” lighting. +6500 is unity. The range is +2000 to +50,000.

– **Tint:** Only available when White Balance is set to something other than As Shot. Designed to alter the green to magenta balance of the image, for images with fluorescent tinting. Lower values add green to compensate for magenta lighting, while higher values add magenta to compensate for green lighting. 0 is unity. The range is –150 to +150.

### CinemaDNG Files and Blackmagic Design Film

Blackmagic Design's logarithmically encoded Blackmagic Design Film gamma setting, which produces flat-contrast, wide-gamut image data that preserves image detail with a wide latitude for adjustment, is a modified version of the standard Cineon curve. However, the modifications are designed to emphasize the strengths of the sensors used by the Blackmagic Design cameras. Similarly to working with clips using Cineon, the ARRI ALEXA's Log-C gamma, or Sony's proprietary S-Log or S-Log2 formats, you need to normalize clips using Blackmagic Design Film by using Resolve Color Management (RCM), by making a manual adjustment to color and contrast, or by applying a LUT, using the same techniques discussed previously.

### Panasonic Varicam RAW

Panasonic Varicam RAW (CRW) is produced by a variety of Panasonic cameras (such as the VariCam 35 and VariCam Pure 4K) recording to Codex VRAW recorders.

### Master Settings

These parameters let you choose the decode quality, white balance, color space, and gamma that raw clips will be transformed to use when debayered.

– **Decode Quality:** Lets you debayer Varicam RAW files at Full, Half, or Quarter resolution to improve performance on slower systems. Lower resolution media is lower quality but faster to work with and process. If necessary, you can choose a lower resolution setting that provides better real time playback on systems with limited performance while you work, and then switch to a higher quality when rendering the final output. A “Force debayer res to highest quality” checkbox in the Render Settings list of the Deliver page makes it easy to follow this workflow.
Decode Using: The option you select determines whether all Varicam RAW media throughout the project is decoded using the original Camera Metadata settings (the default selection), using Project settings in which you choose custom settings to be applied to all clips, or using the Varicam RAW default settings.

Project Settings
Panasonic Varicam RAW has a variety of settings that can be adjusted to alter the image quality of the debayered result. The Color Temp and Tint parameters are only available if the White Balance drop-down menu is set to Custom.

- **White Balance:** The first seven options offer White Balance presets, which automatically adjust the Color Temp and Tint parameters. These options include: Daylight, Cloudy, Shade, Tungsten, Fluorescent, and Flash. An eighth option, Custom, makes the Color Temp and Tint parameters user-adjustable.

- **Sharpness:** A debayer-specific sharpness filter applied to provide the appearance of enhanced image detail. 20 is unity. The range is 0 to 100.

- **Highlights:** Makes it easy to selectively retrieve blown-out highlight detail in high-dynamic-range media by lowering this parameter and achieves a smooth blend between the retrieved highlights and the unadjusted midtones for a naturalistic result. 0 is unity. The range is –100 (minimum) through +100 (maximum).

- **Shadows:** Lets you selectively lighten or darken shadow detail. Raising this value retrieves shadow detail recorded below 0 percent, while leaving the midtones alone. 0 is unity. The range is –100 (minimum) through +100 (very high).

- **Color Boost:** Lets you naturalistically raise the saturation of regions of low saturation, sometimes referred to as a vibrance operation. Can be used also to lower the saturation of regions of low saturation. 0 is unity. The range is –100 (minimum) through +100 (very high).

- **Saturation:** Adjusts the color intensity of the image. 0 is unity. The range is –100 (minimum) through +100 (very high).

- **Midtone Detail:** When this parameter is raised, the contrast of regions of the image with high edge detail is raised to increase the perception of image sharpness, sometimes referred to as definition. When this parameter is lowered to a negative value, regions of the image with low amounts of detail are softened while areas of high-detail are left alone. 0 is unity. The range is –100 (minimum) through +100 (very high).

- **Lift:** Adjusts the black point of the media, raising it or lowering it while scaling all midtone values between it and the white point. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. The range is –100 to +100.

- **Gain:** Adjusts the white point of the media, raising or lowering it while scaling all midtone values between it and the black point. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

- **Contrast:** Raising contrast reduces shadows and raises highlights, while leaving midtones at 50 percent unaffected. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

Use Camera Metadata
The most elemental camera metadata settings for exposure and color that are available.

- **Color Temp:** Only available when White Balance is set to something other than As Shot. Designed to alter the "warmth" of the image. Adjustable in Kelvin. Lower values correct for "warmer" lighting, while higher values correct for "cool" lighting. +6500 is unity. The range is +2000 to +50,000.
– **Tint:** Only available when White Balance is set to something other than As Shot. Designed to alter the green to magenta balance of the image, for images with fluorescent tinting. Lower values add green to compensate for magenta lighting, while higher values add magenta to compensate for green lighting. 0 is unity. The range is –150 to +150.

**Phantom Cine**

The Phantom line of high-speed digital cinema cameras record wide latitude, high-gamut media using the Cine Raw format.

**Master Settings**

These parameters let you choose the decode quality, white balance, color space, and gamma that raw Phantom Cine clips will be transformed to use when debayered.

– **Decode Using:** The option you select determines whether all Phantom Cine media throughout the project is decoded using the original Camera Metadata settings (the default selection), using Project settings in which you choose custom settings to be applied to all clips, or using the Cine default settings.

– **Timecode:** There are four types of timecode that Phantom Cine files can be set to use:
  
  – **Set to zero:** Camera timecode is ignored, instead using a simple frame count with the first frame considered 0.
  
  – **Time of day (Local):** Time of day timecode recording.
  
  – **Time of day (GMT):** Time of day timecode recording based on Greenwich Mean Time.
  
  – **SMPTE:** Standard SMPTE timecode.

**Project Settings**

The following settings for exposure, color, and sharpness are available.

– **Gamma:** Three options are available for setting the gamma of the debayered output:
  
  – Rec. 709
  
  – Log 1
  
  – Log 2

– **Lift:** Adjusts the black point of the media, raising it or lowering it while scaling all midtone values between it and the white point. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. The range is –100 to +100.

– **Gain:** Adjusts the white point of the media, raising or lowering it while scaling all midtone values between it and the black point. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

– **Contrast:** Raising contrast reduces shadows and raises highlights, while leaving midtones at 50 percent unaffected. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

– **Sharpeness:** A debayer-specific sharpeness filter applied to provide the appearance of enhanced image detail. 20 is unity. The range is 0 to 100.

– **Highlights:** Makes it easy to selectively retrieve blown-out highlight detail in high-dynamic-range media by lowering this parameter and achieves a smooth blend between the retrieved highlights and the unadjusted midtones for a naturalistic result. 0 is unity. The range is –100 (minimum) through +100 (maximum).
– **Shadows**: Lets you selectively lighten or darken shadow detail. Raising this value retrieves shadow detail recorded below 0 percent, while leaving the midtones alone. 0 is unity. The range is –100 (minimum) through +100 (very high).

– **Color Boost**: Lets you naturally raise the saturation of regions of low saturation, sometimes referred to as a vibrance operation. Can be used also to lower the saturation of regions of low saturation. 0 is unity. The range is –100 (minimum) through +100 (very high).

– **Saturation**: Adjusts the color intensity of the image. 0 is unity. The range is –100 (minimum) through +100 (very high).

– **Midtone Detail**: When this parameter is raised, the contrast of regions of the image with high edge detail is raised to increase the perception of image sharpness, sometimes referred to as definition. When this parameter is lowered to a negative value, regions of the image with low amounts of detail are softened while areas of high detail are left alone. 0 is unity. The range is –100 (minimum) through +100 (very high).

**RED**

R3D source media, recorded by the various models of RED DIGITAL CINEMA cameras, contains one of the most elaborate sets of raw parameters of any of the camera formats. These settings are divided into four different groups.

**Master RED Settings**

The Master RED settings are the most important, handling decode quality and the control governing whether the original camera metadata is used, or if you're overriding the camera metadata project-wide with custom settings.

These settings also contain the drop-down menus that let you choose the color space and gamma curve used to transform the raw image data into image data for processing in DaVinci Resolve when debayering R3D clips. Which Color Space and Gamma Curve settings you use are solely a matter of preference; there is no absolute requirement to use one or the other for any given type of workflow. You're simply looking for settings that provide the best starting point for the media you have, given the type of grading you’re looking to do.

For example, in many cases combining the REDcolor3 Color Space setting and REDlog Film gamma curve will offer a starting point that retains the most image detail with the greatest latitude for adjustment. On the other hand, if you're working in a hurry, for example to generate dailies for offline editing, using one of the REDcolor Color Space settings with one of the REDgamma settings can offer an image that's more immediately pleasing and that requires fewer adjustments to achieve an acceptable result. These are not recommendations, they’re only examples. As always, the ideal settings for your project depend heavily on the quality of the source media, so you should experiment with media from your own projects to find the most suitable results to your eye.

**Master**

These top settings determine the image quality that you’re choosing to extract from the R3D source media. The tradeoff is that higher quality media at higher resolution will be more processor-intensive to debayer, depending on your workstation’s capabilities.

– **Decode Quality**: Determines the image quality of the decoded R3D data that’s handed off to the DaVinci Resolve image processing pipeline. The Decode Quality you select has a direct impact on real time performance. Decoding performance depends entirely on the hardware capabilities of your system.

On the most modern systems, R3D files can be decoded using accelerated GPU-based debayering if you set the Use GPU for R3D drop-down menu to Debayer in the Decode Options panel of the DaVinci Resolve System Settings. DaVinci Resolve 16.1.2 introduced the latest RED
API-enabling 8K-accelerated debayering using Cuda. Otherwise, R3D files can be decoded with high performance using multi-core CPU processing if your workstation has fast enough CPUs.

If necessary, you can also choose a lower quality setting that provides better real time playback on systems with limited performance while you work, and then switch to a higher quality when rendering the final output. A “Force debayer res to highest quality” checkbox in the Render Settings list of the Deliver page makes it easy to follow this workflow.

– **Bit Depth**: DaVinci Resolve can decode R3D files with 8-, 10-, or 16-bit image data for processing. Choosing 16-bit for maximum quality may impact playback performance on some hardware.

– **Timecode**: The timecode recorded for R3D media depends on the camera setting in use when it was shot. There are three choices:
  
  – **Camera**: This setting automatically selects between Absolute and Edge depending on what was chosen as the default timecode mode on the camera. This setting needs to be selected before you add R3D media to the Media Pool. If you’re browsing R3D media when you change this setting, you should refresh the folder in the Library of the Media Pool before adding media to the Media Pool.
  
  – **Absolute**: The default. Records “time of day” timecode. If an external timecode source was connected and the camera was put into Jam Sync mode, the external timecode would have been recorded instead.
  
  – **Edge**: The first recorded clip for each magazine starts at 01:00:00:00, and the timecode of each subsequent clip is recorded sequentially and continuously.

– **Decode Using**: The option you select determines whether all R3D media throughout the project is decoded using the original Camera Metadata settings (the default selection), using Project settings in which you choose custom settings to be applied to all clips, or using the RED default settings.

### Project Settings

These settings control the fundamental methods used to debayer R3D media. The selections you make to these settings determine the basic color and contrast that you’re choosing to extract from the camera raw image data.

– **Color Science**: The options are Original, which was the color science used by early builds of the REDone camera, Version 2, and IPP2, which is the current version of color science used by the entire RED camera line. Unless you need to match the look of older projects using the older color science, the newest color science is generally preferable.

– **Color Space**: Because RED cameras record R3D data which uses a raw color space, debayering the native R3D data requires choosing a color space to convert the raw signal into. Bear in mind that the color space you choose is merely a starting point for further correction. There is no requirement that you choose one or the other color space for any given workflow. You should choose the color space that provides the most pleasing starting point for your particular project.

  – **DragonColor2**: A further optimized version of DragonColor that is especially recommended for underwater footage.
  
  – **REDcolor4**: A further optimized version of REDcolor3 that is especially recommended for underwater footage.
  
  – **REDWideGamutRGB**: Part of RED’s IPP2 (image processing pipeline 2) initiative; this is a camera color space designed to encompass all colors that can be recorded by RED cameras without clipping, and is meant to provide a single common starting point for all models of RED cameras, for convenient grading to HDR or SDR workflows.
  
  – **Rec. 2020**: Decodes into the standard color space specified by the Rec. 2020 standard for high definition video, UHD video, and beyond. While you may find this option useful, it is not required for programs being output to video.
– **Rec. 709**: Decodes into the standard color space specified by the Rec. 709 standard for high definition video. While you may find this option useful, it is not required for programs being output to video.

– **sRGB**: Decodes into the standard color space defined by the sRGB standard, typically used for computer display.

– **Adobe1998**: Decodes into Adobe’s unique version of the sRGB standard.

– **DCI-P3**: Decodes to an RGB-encoded image data with a D61 white point, intended for use when outputting media for DCI mastering.

– **DCI-P3 D65**: Decodes RGB-encoded image data with a D65 white point, intended for monitoring with a P3-compatible display.

– **ProPhoto RGB**: A color space developed by Kodak that offers a large gamut intended for photography. An idiosyncrasy of this color space is that the green and blue primary points are outside the boundaries of visible color, meaning this gamut encompasses “imaginary” colors in order to achieve an extremely large gamut.

– **CameraRGB**: Outputs the original, unmodified sensor data. Not a recommended setting.

– **REDspace**: Fits the raw R3D image data into a color space that’s larger than that of Rec. 709. Appropriate for digital cinema mastering and film output. REDspace was the predecessor to the REDcolor setting.

– **REDcolor**: A color space that’s similar to the Rec. 709 option, but modified to balance accuracy with pleasing color rendition, emphasizing accurate skin tones.

– **REDcolor2**: Similar, but less saturated than, REDcolor.

– **REDcolor3**: Similar saturation to REDcolor, but with additional modifications to improve the color rendition of skin tone. Introduced as the optimum color space for Epic cameras, but also appropriate for previous generations of RED cameras.

– **DragonColor**: A color space optimized for cameras with the RED Dragon sensor, although this color space can be used for previous generations of RED cameras as well.

– **Gamma Curve**: There are several options available for choosing a gamma profile to be used when debayering the raw R3D data:

  – **REDgamma4**: The latest iteration of the REDgamma curve, designed to give a good in-camera look without the need for grading, while retaining great dynamic range and highlight handling. REDgamma4 is suitable for all RED cameras.

  – **REDlog Film**: An improved logarithmic gamma setting that’s designed to remap the original 12-bit R3D data to the standard Cineon gamma curve. This setting produces flat-contrast image data that preserves image detail with a wide latitude for adjustment, and is compatible with log workflows, including those intended for film output.

  – **Linear**: No gamma adjustment is made, this is a linear-to-light representation of data from the RED camera’s sensor.

  – **Rec. 709**: A gamma curve typical for Rec. 709 display. Does not provide an abundance of latitude for grading.

  – **Gamma 2.4**: A simple power-function gamma setting commonly used for broadcast.

  – **Gamma 2.6**: A simple power-function gamma setting commonly used for digital cinema projection.

  – **sRGB**: Similar gamma setting to that employed by Rec. 709.

  – **HDR ST.2084**: The standardized gamma curve for high-dynamic-range (HDR) video. Also referred to as the PQ curve.

  – **Hybrid Log Gamma**: The standardized gamma curve for the HLG standard of high-dynamic-range (HDR) video jointly developed by the BBC and NHK.
– **BT.1886**: The standardized gamma curve for standard-dynamic-range HD and UHD display. Does not provide an abundance of latitude for grading.

– **Log3G12**: An expanded option for RED’s IPP2 (image processing pipeline 2) initiative, this is a wide dynamic range log space designed to encode camera data from all RED models to a common starting point in RWG color space for convenient grading to HDR or SDR workflows. Log3G12 provides 12 stops of dynamic range above mid gray, 2 more stops than Log3G10. However, this is at the expense of a slight loss of precision.

– **Log3G10**: Part of RED’s IPP2 (image processing pipeline 2) initiative, this is a wide dynamic range log space designed to encode camera data from all RED models to a common starting point in RWG color space for convenient grading to HDR or SDR workflows. 3G represents the mapping of 18% mid gray to 1/3, and 10 represents the 10 stops of dynamic range above mid gray this supports.

– **Plog 685**: A logarithmic gamma setting that maps the native 12-bit RED image data into the linear portion of a Cineon or film transfer curve.

– **Plog 985**: A logarithmic gamma setting with different mappings.

– **Custom Plog**: A logarithmic gamma setting that exposes user adjustable Black Point, White Point, and Gamma Plog parameters so you can customize your own log gamma curve.

– **REDSpace**: Similar to Rec. 709, but slightly altered to be more appealing, primarily through higher contrast and lighter midtones. The predecessor to the REDgamma curve.

– **REDlog**: A logarithmic gamma setting that maps the original 12-bit R3D image data to a 10-bit curve. The blacks and midtones occupying the lowest 8 bits of the video signal maintain the same precision as in the original 12-bit data, while the highlights that occupy the highest 4 bits are compressed. While reducing the precision of highlight detail, the tradeoff is that there’s an abundance of precision throughout the rest of the signal. This is a good setting for maintaining maximum latitude.

– **REDgamma**: An improved gamma curve designed to be perceptually appealing on displays calibrated for Rec. 709, with an improved soft roll-off in the highlights to maintain highlight detail while grading.

– **REDgamma2**: Similar to REDgamma, with higher contrast.

– **REDgamma3**: The most recent iteration of the REDgamma curve. Based on a log starting point, but with a pleasing “ready to view” contrast curve applied, designed to be a visually pleasing starting point that maintains excellent dynamic range. REDgamma3 is also designed to work with REDcolor3.

– **Blend Type**: Works to control how RED HDRX media is used. When using either Simple or Magic Motion to blend HDRX exposures, there’s no need to use the second output in the Node Editor. You can choose from three options:

  – **None**: Only the regular exposure is used.

  – **Simple**: Blends the two HDRX exposures to achieve a pleasing middle ground.

  – **Magic Motion**: Uses a proprietary algorithm to combine the dual exposures to combine overexposed and well-exposed regions of the picture in a more targeted fashion, while blending the sharpness of the regularly exposed source with the motion blur of the underexposed source.

– **Blend Bias**: Lets you adjust how much of the regular exposure and how much of the underexposure are combined.

– **Apply Metadata Curves**: If the R3D media files were preprocessed in REDCINE X Pro, and saved with color curve metadata, you can use this setting to either use or discard that metadata.
– **D.E.B. (Dragon Enhanced Blacks):** A checkbox that enables the elimination of red noise in RED cameras using the Dragon sensor.

– **Embedded Audio:** Enables embedded audio in R3D media.

**Decoder Settings**

This second group of settings contains additional controls for finessing the debayering of RED raw image data. Which controls are exposed depends on which Color Science setting is selected above. Many of the settings in this group are color correction adjustments, some of which resemble analogous controls in the Color page. However, the FLUT and DRX controls manage the exposure of the debayered media being fed to the DaVinci Resolve image processing pipeline, and so can be used to retrieve image detail from R3D source media in cases where the default settings are clipping or crushing detail in the highlights or shadows that would be unavailable to DaVinci Resolve as a result.

– **De-noise:** Applies image-wide noise reduction. There are seven settings available, from mild to maximum, that you can use to balance noise reduction against any possible image degradation.

– **OLPF Compensation:** (color science versions 1 and 2) OLPF compensation applies a low pass filter to reduce color moiré. There are four options: Off (the default), Low, Medium, and High.

– **Image Detail:** (color science versions 1 and 2) Controls the demosaicing algorithm that’s used for the software decoding of R3D media. You can choose a level of sensor detail extraction: Low, Medium, and High (recommended). If you’re using a RED ROCKET card, this setting is ignored as there is a fixed algorithm that’s used.

– **FLUT:** (color science versions 1 and 2) A gain operation that lets you boost or attenuate the ISO in smaller increments. 0 is unity. The range is –8 to +8.

– **Contrast:** Raising contrast reduces shadows and raises highlights, while leaving midtones at 50 percent unaffected. The image is compressed rather than clipped at the limits of 100 and 0 percent. 0 is unity. The range is –1 to +1.

– **Saturation:** (color science versions 1 and 2) Adjusts the color intensity of the image. 1 is unity. The range is 0 (minimum) through 5.0 (very high).

– **DRX:** (color science versions 1 and 2) A Dynamic Range control (X) that lets you recover highlights while taking into account Color Temperature (degrees Kelvin) and Tint. 0 is unity, and 1.0 is the maximum value.

– **Shadow:** (color science version 1 and 2) Provides control over the toe (low range) of the FLUT adjustment. 0 is unity. The range is –2 to +2.

– **Brightness:** Adjusts image lightness. Image data is compressed rather then clipped at 100 and 0 percent. 0 is unity. The range is –10 to +10.

– **Flashing pixel adjust:** A setting to apply noise reduction for removing or minimizing any flashing pixels recorded from the sensor. Levels are: None, Low, Medium, and High.

Three additional parameters are available for IPP2 workflows, but they only function when DaVinci Resolve is set to use DaVinci YRGB Color Managed color science and the Timeline to Output Gamut Mapping in the Color Management panel of the Project Settings is set to RED IPP2 Gamut Mapping. These controls (which are also mirrored in the Color Management panel when enabled) are designed to let you tone map wide gamut media that’s being graded to a smaller gamut, such as Rec. 709.
The RED IPP2 Gamut Mapping controls that appear in the Color Management tab of the Project Settings.

- **Output Tone Map**: (color science IPP2) Provides an easy setting for setting the resulting contrast when tone mapping wide dynamic range images to standard dynamic range (SDR) output. Settings are: None, Low, Medium, and High. Low results in less contrast; High results in more contrast.

- **Highlight Roll Off**: (color science IPP2) Five settings let you adjust how much to roll off the highlights to fit within the current gamut. These are: None, Hard, Medium, Soft, and Very Soft. Hard provides a minimum of roll-off; Very Soft provides a maximum of roll-off. This setting interacts with the HDR Peak Nits slider below.

- **HDR Peak Nits**: (color science IPP2) Adjusts the amount of highlight compression that’s done by Highlight Roll Off.

**Use Camera Metadata**

The most elemental camera metadata settings for exposure and color that are available.

- **ISO**: A gain operation that keeps the black point at 0 while raising or lowering the white point of the image, linearly scaling everything in between. Raising the ISO results only in boosted highlights being more compressed; no clipping will occur. 320 is unity. The range is 50–6400.

- **Exposure Adjust**: Increases or lowers image lightness in units relative to f-stops. Using exposure to boost the image beyond 100 or to lower it below 0 will clip, not compress, the image data that’s passed along to the DaVinci Resolve image processing pipeline. 0 is unity. The range is –7 to +7.

- **Color Temp**: Designed to alter the “warmth” of the image while keeping white elements of the scene looking neutral. Adjustable in degrees Kelvin. Lower values correct for “warmer” lighting, while higher values correct for “cool” lighting. This parameter is designed specifically to adjust RED linear light image data to make the most photometrically accurate correction. 5600 is unity. The range is 1700 to 10,000.

- **Tint**: Color balance correction for images with a green or magenta color cast, such as fluorescent or sodium vapor bulbs. This parameter is designed specifically to adjust RED linear light image data to make the most photometrically accurate correction. 0 is unity. The range is –100 to +100.

**Sony RAW**

Sony makes several digital cinema cameras, such as the F65 and F55, that record wide latitude, high-gamut media either using Sony’s 12-bit SR codec, or as 16-bit raw media files. Since Sony’s cameras do not use a traditional Bayer pattern, special debayering is necessary when working with F65 raw media, and the image data is demosaiced using the following raw controls and parameters.

**Master Settings**

These parameters let you choose the decode quality, white balance, color space, and gamma that Sony raw clips will be transformed to use when debayered.
– **Decode Quality:** Determines the image quality of the decoded Sony raw data that’s handed off to the DaVinci Resolve image processing pipeline regardless of the Play Quality setting. The Decode Resolution you select has a direct impact on real time performance, and decoding performance depends entirely on the hardware capabilities of your system.

If necessary, you can choose a lower resolution setting that provides better real time playback on systems with limited performance while you work, and then switch to a higher quality when rendering the final output. A “Force debayer res to highest quality” checkbox in the Render Settings list of the Deliver page makes it easy to follow this workflow.

– **Decode Using:** The option you select determines whether all F65 media throughout the project is decoded using the original Camera Metadata settings (the default selection), using Project settings in which you choose custom settings to be applied to all clips, or using the Sony default settings.

**Project Settings**

These settings control the fundamental methods used to debayer Sony raw media. The selections you make to these settings determine the basic color and contrast that you’re choosing to extract from the camera raw image data.

– **White Balance:** The first seven options offer White Balance presets, which automatically adjust the Color Temp and Tint parameters. These options include: Daylight, Cloudy, Shade, Tungsten, Fluorescent, and Flash. An eighth option, Custom, makes the Color Temp and Tint parameters user-adjustable.

– **Color Space:** Multiple color spaces are adjustable, depending on your intended workflow:
  – **Rec. 709:** Decodes into the standard color space specified by the Rec. 709 standard for high definition video.
  – **P3 D60:** Decodes RGB-encoded image data with a D60 white point, intended for monitoring with a P3-compatible display.
  – **SGamut:** Decodes into Sony’s wider S-gamut color space, designed to provide the widest range of image data for adjustment.
  – **SGamut3:** The gamut is identical to SGamut, but color reproduction is more accurate, according to Sony’s “Technical Summary for S-Gamut3Cine/S-Log3 and S-Gamut3/S-Log3” whitepaper.
  – **SGamut3.Cine:** According to Sony’s “Technical Summary for S-Gamut3Cine/S-Log3 and S-Gamut3/S-Log3” whitepaper, S-Gamut3.Cine is designed to provide a more traditionally log-encoded workflow with color reproduction that is slightly wider than the P3 gamut.
  – **P3:** Decodes to an RGB-encoded image data with a D61 white point, intended for use when outputting media for DCI mastering.
  – **ACES:** Decodes to image data that maps to the ACES profile for the camera that was used.

– **Gamma:** Five gamma settings are available, depending on what starting point you want to use for further grading.
  – **Gamma 2.4:** A simple power-function gamma setting commonly used for broadcast.
  – **Gamma 2.6:** A simple power-function gamma setting commonly used for digital cinema projection.
  – **Rec. 709:** A gamma curve typical for Rec. 709 display.
  – **SLog:** Not designed for viewing, Sony’s SLog gammas are designed to provide a wide latitude for grading; 14-stops according to Sony. 18% gray is at 38%.
– **SLog2**: This version has a half stop offset from SLog to allow for a higher dynamic range. 18% gray is at 32%.

– **SLog3**: An “easier to grade” version of SLog. 18% gray is at 40%. According to Sony’s “Technical Summary for S-Gamut3Cine/S-Log3 and S-Gamut3/S-Log3,” SLog3 is designed to provide a more traditionally log-encoded workflow, with a gamma curve that is similar, but not identical, to Cineon workflows.

– **Linear**: A simple linear gamma setting.

– **Lift**: Adjusts the black point of the media, raising it or lowering it while scaling all midtone values between it and the white point. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. The range is –100 to +100.

– **Gain**: Adjusts the white point of the media, raising or lowering it while scaling all midtone values between it and the black point. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

– **Contrast**: Raising contrast reduces shadows and raises highlights, while leaving midtones at 50 percent unaffected. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

– **Sharpness**: A debayer-specific sharpness filter applied to provide the appearance of enhanced image detail. 20 is unity. The range is 0 to 100.

– **Highlights**: Makes it easy to selectively retrieve blown-out highlight detail in high-dynamic-range media by lowering this parameter, and achieves a smooth blend between the retrieved highlights and the unadjusted midtones for a naturalistic result. 0 is unity. The range is –100 (minimum) through +100 (maximum).

– **Shadows**: Lets you selectively lighten or darken shadow detail. Raising this value retrieves shadow detail recorded below 0 percent, while leaving the midtones alone. 0 is unity. The range is –100 (minimum) through +100 (very high).

– **Color Boost**: Lets you naturally raise the saturation of regions of low saturation, sometimes referred to as a vibrance operation. Can be used also to lower the saturation of regions of low saturation. 0 is unity. The range is –100 (minimum) through +100 (very high).

– **Saturation**: Adjusts the color intensity of the image. 0 is unity. The range is –100 (minimum) through +100 (very high).

– **Midtone Detail**: When this parameter is raised, the contrast of regions of the image with high edge detail is raised to increase the perception of image sharpness, sometimes referred to as definition. When this parameter is lowered to a negative value, regions of the image with low amounts of detail are softened while areas of high-detail are left alone. 0 is unity. The range is –100 (minimum) through +100 (very high).

**Use Camera Metadata**

The most elemental camera metadata settings for exposure and color that are available.

– **Exposure**: Increases or lowers image lightness in units relative to ASA values. If your intended exposure adjustment lifts image data above the maximum white level, don’t worry; all image data is preserved and can be retrieved in subsequent adjustments. +800 is unity. The range is +1 to +65,535.

– **Color Temp**: Designed to alter the “warmth” of the image. Adjustable in degrees Kelvin. Lower values correct for “warmer” lighting, while higher values correct for “cool” lighting. +6500 is unity. The range is +2000 to +50,000.
– **Tint**: Only available when White Balance is set to something other than As Shot. Designed to alter the green to magenta balance of the image, for images with fluorescent tinting. Lower values add green to compensate for magenta lighting, while higher values add magenta to compensate for green lighting. 0 is unity. The range is –150 to +150.

---

**Sony Media and SLog**

Sony’s proprietary SLog gamma setting, which produces flat-contrast, wide-gamut image data that preserves image detail with a wide latitude for adjustment, is also available on some other Sony cameras. Similarly to working with clips using the ARRI ALEXA’s Log-C gamma, you need to normalize SLog clips by using Resolve Color Management (RCM), by making a manual adjustment to color and contrast, or by applying a LUT, using the same techniques discussed previously.

When applying a LUT, there are two methods that Sony recommends. A 1D LUT can be used to transform SLog clips into the standard Cineon (or Log-C) curve if your ultimate goal is to output Log media for film printing. If you’re planning to output to a normalized format, you can use a dedicated LUT to make this transformation.

For more information, search the web for Sony’s document “SLog: A new LUT for digital production mastering and interchange applications.”
DaVinci Resolve is a high-performance piece of software designed to enable real time effects on a variety of workstations. This section describes the various ways you can monitor your performance to make sure you’re maintaining real time playback, along with different methods of optimizing real time performance, including using on-the-fly proxies and the background Render Cache.

Contents

Understanding the GPU Status Display 160
Prioritizing Audio or Video Playback in the Edit Page 160
Performance Mode Improves Overall Performance 161
Adjusting Performance Mode 161
Timeline Proxy Mode Improves Effects Performance 161
Reducing Decode Quality Improves Raw Media Performance 162
Optimized Media Improves Overall Performance
Creating Optimized Media
Optimized Media for Raw Source Clips
Customizing the Type of Optimized Media You Create
Switching Between Optimized and Original Media
Sharing Optimized Media Between Projects
Rediscovering Lost Optimized Media
Deleting Optimized Media
Using Optimized Media for Delivery
Using the Smart or User Cache Improves Effects Performance
How Cached Media Is Organized
Choosing a Cache Format and Location
When Caching Happens
The Difference Between the Smart Cache and User Cache Modes
Manually Controlling the Cache
Controlling Fusion Output Caching
Controlling Node Caching
Controlling Color Output Caching
Controlling Edit Page Filter Caching
Clearing Cached Media
Using Cached Media When Rendering in the Deliver Page
Using Proxy Media
Creating and Using Proxy Media
Generating Proxy Media in Other Applications
Managing Proxy Media
Using Proxy Files for Delivery
Moving Proxies Using a DaVinci Resolve Archive (.dra)
Working Remotely Using Proxy Media
Proxy Media vs. Other Playback Optimizations in DaVinci Resolve
Using Optimized Media, Proxy Media, and Caching Together
Which Playback Optimization Method Should I Use?
Other Project Settings That Improve Performance
Understanding the GPU Status Display

Every viewer in DaVinci Resolve exposes a GPU status indicator and a frame-per-second (FPS) meter, which appears in the Viewer’s title bar, which shows you your workstation’s performance whenever playback is initiated. Since DaVinci Resolve uses one or more GPUs (graphics processing units) to handle all image processing and effects, the GPU status display shows you how much processing power is being used by whichever clip is playing.

A green status indicator shows there is plenty of GPU processing headroom available. As the GPU resources is increasingly taxed, this green graph eventually turns red to show that the available GPU power is insufficient for consistent real time playback.

Eventually, as you add more and more effects and corrections, you’ll reach the limits of available performance, forcing DaVinci Resolve to either drop frames, or play video at a slower speed in order to maintain high image quality, shown by the red FPS indicator.

When real time performance falls short, DaVinci Resolve provides a variety of controls and options that let you enhance real time playback and effects. Each is useful for different situations, and all can work together so you can choose the best trade-off between image quality and performance while you work. All of these methods can be set up to have no effect on your delivered output.

Prioritizing Audio or Video Playback in the Edit Page

When available processing power is insufficient to play the clip or clips at the position of the playhead due to the grade, transforms, or effects that are applied at that moment in the Timeline, you have the ability to choose exactly how performance in DaVinci Resolve degrades, by turning the “Show All Video Frames” on or off in the Option menu of the Edit page Viewers.

– **Show All Video Frames off**: The default setting, ideal for video editing. Prioritizes audio playback at the expense of dropping video frames when processing power is tight, resulting in a more conventional playback experience.

– **Show All Video Frames on**: An alternate setting that’s ideal when you’re doing effects work, for which you need to see every single frame play back, sequentially. Audio quality is compromised while every frame of video plays in slower-than-real-time, if necessary, to maintain playback.

Keep in mind that this setting only affects playback when GPU performance is lacking. In areas of the Timeline where performance is adequate, playback remains uncompromised.
Performance Mode Improves Overall Performance

Performance Mode, which is found in the Playback Settings of the User Preferences, analyzes your computer’s configuration, the CPU, GPU, connected video interface, and so on, and automatically tunes DaVinci Resolve’s under-the-hood image processing settings to provide the best interactivity on your machine. It’s set to Automatic by default, although you can choose to adjust its effect manually, or disable it altogether. When enabled, Performance Mode dramatically improves the experience of editing, mixing, and grading on less powerful computers.

While Performance Mode is turned on, DaVinci Resolve still outputs to video, renders in the Delivery page, and processes via the Media Management command at the highest quality. As a result, using Performance Mode makes no compromise in the quality of your output, so creative editors and audio mixers can leave this setting on always.

Finishing editors and colorists might notice subtle differences between the image on your computer monitor on less powerful computers when Performance Mode is on versus when it’s off, which is why this setting can be disabled, either entirely or in part using checkboxes in the Playback Settings panel of the User Preferences for instances where GUI interactivity is less important than your onscreen display.

Adjusting Performance Mode

A pair of radio buttons in the Playback Settings panel of the User Preferences let you choose between Automatic (default) and Manual behaviors when you turn on Performance Mode in DaVinci Resolve. Set to Automatic, Performance mode automatically optimizes a variety of operations in a bid to balance performance with the necessary level of image quality, for fast onscreen performance while always maintaining the highest level of quality for video output.

Set to Manual, there are three different settings you can choose to disable for instances where a particular performance tradeoff results in an undesirably noticeable reduction in image quality in Performance Mode:

- **Optimized Sizing:** Relates to how image resizing is handled.
- **Optimized Decode Quality:** Relates to how clip resolution vs. timeline resolution is handled.
- **Optimized Image Processing:** Relates to how image processing operations are handled.

Timeline Proxy Mode Improves Effects Performance

If you don’t want to either drop frames or play at slower than real time speed whenever the GPU Status indicator is in the red, an immediate way of improving performance is to turn on the Use Timeline Proxies option in the Playback menu. Using timeline proxies reduces processing demands by taking advantage of the resolution independence of DaVinci Resolve to lower the resolution of your clips on-the-fly, thereby increasing real time playback performance without the need to spend time caching part or all of the timeline, or create optimized media (both discussed later).

To turn Use Timeline Proxies on and off, do one of the following:

- Choose Playback > Timeline Proxy Mode > Half Resolution, Quarter Resolution, or None.
- Press PROXY ON/OFF on the T-bar panel of the DaVinci control panel (Defaults to the last proxy resolution you selected from the menu. Half is the default if you haven’t selected a resolution yet.).
Turning on one of the proxy resolutions reduces the working resolution by either half or a quarter of whatever the current Timeline resolution is for your project. Working at a temporarily reduced resolution increases your workstation’s real time performance, while the resolution independence of Resolve guarantees that every window you draw and sizing operation you make scales correctly to the actual resolution of your project.

<table>
<thead>
<tr>
<th>Proxy Resolution</th>
<th>Width</th>
<th>Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full 8K UHD</td>
<td>7680</td>
<td>4320</td>
</tr>
<tr>
<td>Full UHD/Half 8K UHD</td>
<td>3840</td>
<td>2160</td>
</tr>
<tr>
<td>Full-HD/Half UHD/Quarter 8K UHD</td>
<td>1920</td>
<td>1080</td>
</tr>
<tr>
<td>Half-HD/Quarter UHD/Eighth 8K UHD</td>
<td>960</td>
<td>540</td>
</tr>
<tr>
<td>Quarter-HD/Eighth UHD/Sixteenth 8K UHD</td>
<td>480</td>
<td>270</td>
</tr>
</tbody>
</table>

Table of half and quarter proxy resolutions for different television frame sizes

**Important**
Timeline Proxy Mode is entirely different and independent of the creation of Proxy Media as described later in this chapter. The two functions, Timeline Proxy Mode and Proxy Media, have no relation to each other.

Reducing Decode Quality Improves Raw Media Performance

The Use Proxy command will improve performance when grades and effects are responsible for your project’s slower than real time playback, but Use Proxy won’t help when real time performance is being used up by the need to debayer raw media. While you could improve playback performance by taking the time to either generate optimized media (see below) or render to the Fusion Output Cache by enabling the Smart Cache (see later in this chapter), the fastest solution is to open the Camera Raw panel of the Project Settings and reduce the Decode Quality of the raw media formats you’re using:

- **Decode Quality:** Camera raw formats such as R3D and F65 can be debayered at different levels of quality. For higher real time performance, you can choose a lower quality setting while you work, and then switch to a higher quality when rendering the final output.

Options for reducing resolution vary by each raw format’s differing capabilities, but at the very least include full, half, and quarter resolution (R3D and Sony Raw have options for full, half, quarter, eighth, and sixteenth). Exceptions include the Canon RAW, Panasonic Varicam RAW, and Phantom Cine formats, which only decode to full resolution.

If you reduce the decode quality of raw media formats in your project to improve performance, you can use the “Force debayer res to highest quality” checkbox in the Render Settings list of the Deliver page to ensure that DaVinci Resolve renders all raw formats at the highest quality available, so you don’t have to worry about forgetting to change the decode quality back when it’s time to render your deliverables.
Optimized Media Improves Overall Performance

If you’re editing processor-intensive source formats such as camera raw, H.264, or 8K media, and your computer isn’t fast enough to work with it easily in real time, you can create pre-rendered, low-overhead duplicate media to use instead, that’s automatically managed alongside the original media. This is called “Optimized Media.” Optimized Media lets you work more quickly by allowing you to edit with a more processor-efficient media format and resolution, while providing the ability to easily switch your project back to the original source media whenever you want. So, you can use Optimized media to edit, and switch back to the original source media when it’s time to finish and output. Switching is as easy as choosing Playback > Use Optimized Media if Available to toggle Optimized media on and off.

The advantage of using optimized media to help you work faster is that it’s pre-generated, meaning you can render it once and then use the files for the duration of your work in that project (unless you change the debayering settings of the raw media). Also, optimized media improves the playback performance of clips throughout DaVinci Resolve, including in the Media page and in the Media Pool and Source Viewer of the Edit page, whereas the similar but different Fusion Output Cache component of the Smart Cache only improves the performance of clips that are already in the Timeline by caching them at the Timeline resolution. This makes optimized media ideal for editing workflows of all kinds.

Choosing the Appropriate Optimized Media Format for Your Project

You have the option of choosing the Format of the optimized media you create, using controls in the Master Settings panel of the Project Settings. Be aware that the format you choose via the “Optimized Media Format” menu will determine whether out-of-bounds image data (also known as “overshoots”) and Alpha Channels are preserved when the clip is cached.

– Preventing Clipping: You should use 16-bit float, ProRes 4444, ProRes 4444 XQ, or DNxHR 444 if you plan on grading using optimized media. This is particularly true for HDR grading.

– Preserving Alpha Channels: Also be aware that the format you choose will determine whether Alpha Channels will be preserved if they’re present in the clips being optimized. Currently, the Uncompressed 10-bit, Uncompressed 16-bit Float, ProRes 4444, ProRes 4444 XQ, and DNxHR 444 formats preserve alpha channels.

Creating Optimized Media

Creating optimized media to work with is easy. Resolve automatically manages the relationship between source clips and the optimized media you create, so all you need to do is choose which clips to make optimized media for. You can manually choose which clips to optimize, or you can use a Smart Bin to collect all of the media corresponding to one or more formats you need to optimize to gather it procedurally. In either case, this gives you the option of only optimizing clips in formats that require optimization, saving you time.

For example, if you’re editing a project that consists half of camera raw media, and half of DNxHD media, you probably only need to optimize the camera raw media, so you can create a Smart Bin that gathers all of it, based on Resolution, Codec, File Name, or whatever other metadata is appropriate. Once gathered, it’s an easy thing to select all of these clips in preparation for the next step.

To create optimized media for one or more selected clips:

– Right-click one of the selected clips, and choose Generate Optimized Media from the contextual menu.
All optimized media is written to the same directory as the Cache files are written, which defaults to the first scratch disk listed in the Preference dialog’s Media Storage panel. The location of Cache and Optimized files is also selectable via the “Cache files location” setting in the Master Settings panel of the Project Settings.

**Optimized Media for Raw Source Clips**

In general, once you create optimized media, DaVinci Resolve keeps track of it and continues using it regardless of whatever changes you make to your project, including changing the Timeline resolution. However, any change to the camera raw settings of optimized clips will automatically discard the optimized media, requiring you to re-generate optimized media for them.

**Customizing the Type of Optimized Media You Create**

The Master Settings panel of the Project Settings has a set of controls that govern what kind of media files are created when you create optimized media.

There are two settings affecting Optimized Media in the Optimized Media and Render Cache section:

- **Resolution:** Lets you choose whether to create optimized media at the same size as your original media files (by choosing Original), or to reduce the bandwidth of your optimized media further by reducing its resolution by a Half, Quarter, Eighth, or Sixteenth. The “Choose automatically” option tries to balance visual quality with efficiency by only reducing the resolution of media files that are larger than the currently selected Timeline resolution, using whatever reduction ratio best matches the Timeline resolution.

- **Optimized Media Format:** Lets you choose the format and codec with which to generate optimized media. Options include Uncompressed 10-bit, and Uncompressed 16-bit float for maximum quality. Other options include ProRes Proxy through 4444 XQ, and DNxHR LB through 444. All options will store image data in the optimized and proprietary .dvcc image format. While smaller formats take less room on your scratch disk, there are two good reasons to use higher-quality formats for creating Optimized Media.

  - **Preventing Clipping:** Be aware that the format you choose will determine whether out-of-bounds image data is preserved when the signal is optimized. If you find that image data (typically super-white levels) are clipped after optimization, you should switch to 16-bit float, ProRes 4444, or ProRes 4444 XQ; in particular, any of these three codecs are appropriate optimized formats for HDR grading.

  - **Preserving Alpha Channels:** Also be aware that the format you choose will determine whether Alpha Channels will be preserved, if they’re present in the clips being Optimized. Currently, the Uncompressed 10-bit, Uncompressed 16-bit Float, ProRes 4444, ProRes 4444 XQ, and DNxHR 444 formats preserve alpha channels.
Choosing Resolution Automatically

The “Choose automatically” option of the Resolution setting bears a bit more explanation. When selected, only source media with a higher resolution than the selected Timeline resolution will generate downsized optimized media. How much each clip will be downsized depends on how much larger each clip is than the Timeline resolution. For example, if you’re working within a 1080 resolution project, then 8K clips will generate quarter-resolution optimized media, and 4K clips will generate half-resolution optimized media, such that all optimized media is somewhere around 1080 resolution. All clips that are 1080 and smaller generate optimized media at the same resolution as the source clips.

In the example of a 4K project, 8K clips will generate half-resolution optimized media, and all other clips that are 4K and smaller will generate optimized media at the same resolution as the source clips.

<table>
<thead>
<tr>
<th>Proxy Resolution</th>
<th>Width</th>
<th>Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full 8K UHD</td>
<td>7680</td>
<td>4320</td>
</tr>
<tr>
<td>Full UHD/Half 8K UHD</td>
<td>3840</td>
<td>2160</td>
</tr>
<tr>
<td>Full-HD/Half UHD/Quarter 8K UHD</td>
<td>1920</td>
<td>1080</td>
</tr>
<tr>
<td>Half-HD/Quarter UHD/Eighth 8K UHD</td>
<td>960</td>
<td>540</td>
</tr>
<tr>
<td>Quarter-HD/Eighth UHD/Sixteenth 8K UHD</td>
<td>480</td>
<td>270</td>
</tr>
<tr>
<td>Eighth-HD/Sixteenth UHD</td>
<td>240</td>
<td>135</td>
</tr>
</tbody>
</table>

Table of optimized resolutions for different television frame sizes

Switching Between Optimized and Original Media

Choosing whether or not you’re using optimized media is easy. Simply choose Playback > Use Optimized Media if Available to switch your entire project between using optimized media (if it’s been generated), or the original media. Furthermore, a checkbox in the Render Settings of the Deliver page lets you choose whether you want to use optimized media to speed up rendering, or render using the original media only.

**NOTE:** Optimized media is not included in Media Management operations, nor is it included as part of Archive operations in the Project Manager.

Sharing Optimized Media Between Projects

Optimized Media is shared across projects in the same database (previously optimized media was confined to a single project). This means that if you create optimized media for a clip in one project, that same optimized media will be used for that clip in any other project that’s in the same database. This happens automatically and requires no user input. This will dramatically cut down the space requirements for working with the same media across different projects.

Rediscovering Lost Optimized Media

It’s difficult, but it is possible to lose track of optimized media you’ve generated in certain rare circumstances. For example, if you generate optimized media on another workstation, but failed to save the project, DaVinci Resolve may lose the relationship between the clips in the Media Pool and the optimized media files you created. In these cases, it’s possible to rediscover the optimized media so you don’t have to regenerate it.
To rediscover lost optimized media:
Select the clips in the Media Pool for which you know you have optimized media, then right-click one of the selected clips and choose Rediscover Optimized Media from the contextual menu.

Deleting Optimized Media
The optimized media you generate within a project is persistent; it’s saved for future use even when the project is closed and later reopened. If you need to delete optimized media to free up space on your scratch volume (or wherever you’ve decided to locate your project’s cache files), you must delete the optimized media manually in your OS. By default, the Optimized Media is stored in the first volume in the Media Storage tab of the System Preferences.

Using Optimized Media for Delivery
An option in the More options section of the Render Settings in the Deliver page, “Use Optimized Media,” lets you output using Optimized Media, rather than the original media, in order to save rendering time. If you’re planning on using this option, it’s advisable to set the Optimized media format to a suitably high-quality HDR-capable format to guarantee the best results.

Using the Smart or User Cache Improves Effects Performance
Another option for achieving real time performance when the GPU Status indicator is in the red due either to Timeline effects, Color page grading, or processor-intensive media in the Timeline, is to use the Smart Cache or User Cache modes of the Render Cache. What DaVinci Resolve calls “caching” is sometimes referred to by other applications as “rendering.” Both terms refer to the behind-the-scenes creation of new media, with all effects “baked in,” which DaVinci Resolve plays back in real time in place of the original source media containing processor-intensive effects at the same time. This results in smooth playback without the risk of dropped frames.

The DaVinci Resolve Smart Cache and User Cache automatically render and cache clips, including simple video clips, compound clips, Fusion clips, and nested timelines that have processor-intensive grades and effects applied to them, or that you manually flag for caching by right-clicking any clip in the Color page or Edit page timeline and enabling the Render Cache Clip Output option. When the Smart or User Caches are enabled, frames of each automatically or manually flagged clip are cached either during playback in the Timeline, or automatically whenever you pause work, to the “Cache files location” specified in the Master Settings panel of the Project Settings.

The settings governing caching in the Master Settings panel of the Project Settings

Once you’ve cached clips in the Timeline, they play back in real time until they’re modified, which automatically flushes the now out-of-date cache files for those modified clips and triggers the need to re-cache.
To use clip caching on any page, do one of the following:

- Choose Playback > Render Cache > Smart to set DaVinci Resolve to automatically cache computationally intensive effects and timeline clips in formats judged too processor-intensive to play in real time.
- Choose Playback > Render Cache > User to set DaVinci Resolve to cache clips and effects that you manually choose to cache, as well as automatically caching processor-intensive effects (transitions, composites, and Fusion Effects) you specify in the Master Settings of the Project Settings.
- Choose Playback > Render Cache > Off to disable all render caching.
- In the Color and Edit pages, press Option-R to cycle among Off, Smart, and User.
- Press CACHE MODE on the T-bar panel of the DaVinci control panel to toggle among the available options.

Choosing the Appropriate Cache Media Format for Your Project

You have the option of choosing the Format of the cached media you create, using controls in the Master Settings panel of the Project Settings. Be aware that the format you choose via the “Render Cache Format” menu will determine whether out-of-bounds image data (also known as “overshoots”) and Alpha Channels are preserved when the clip is cached.

- Preventing Clipping: You should use 16-bit float, ProRes 4444, ProRes 4444 XQ, or DNxHR 444 if you plan on grading using cached media. This is particularly true for HDR grading.
- Preserving Alpha Channels: Also be aware that the format you choose will determine whether Alpha Channels will be preserved, if they’re present in the clips being cached. Currently, the Uncompressed 10-bit, Uncompressed 16-bit Float, ProRes 4444, ProRes 4444 XQ, and DNxHR 444 formats preserve alpha channels.

How Cached Media Is Organized

The cache mechanism in DaVinci Resolve actually comprises three independently managed media caches that interact with one another. This is done to keep you working quickly by ensuring that changes you make to your timeline don’t require a grade to be re-cached, and that changes you make to a grade don’t require the timeline to be re-cached. The three levels of caching are:

First, Fusion Output Caching

Formerly called the “Source Cache” in previous versions of DaVinci Resolve. When enabled by turning on the Smart Cache, by individually turning on Render Cache Fusion Output for a particular clip, or by enabling the automatic caching of clips with Fusion Effects applied in the Project Settings, this caches the portion of each source media file that appears in the Timeline in its pre-graded state for clips that have the following characteristics:

- Clips in media formats DaVinci Resolve considers to be processor-intensive to decode, such as H.264, HEVC, and various raw camera formats
- Clips with Speed or Retime effects
- Clips with Fusion Effects that have been added in the Fusion page
- Titles and Generators that are processor intensive

Effectively, this is a “pre-Color page” cache. By caching all processor-intensive clips in the Timeline, you’ll experience vastly improved trimming and grading performance. However, you also have the...
option to turn the Fusion Output Cache on or off for individual clips, or for multiple selected clips all at once. This lets you switch between using the native source of each clip with live effects, or the cached clip in the cache format you’ve chosen.

The advantage of the Fusion Output Cache over Optimized Media is that you only cache clips that are used in a timeline, which is ideal for finishing workflows. However, the Smart and User caches aren’t useful for speeding up work done with source media in the Media Pool and Source Viewer when you’re at the very beginning of an edit; that’s what Optimized Media is for (as described in the previous section).

If Optimized media exists for a given clip, and “Use Optimized Media if available” is turned on, then Optimized media will be used instead of the Fusion Output Cache if there are no Speed effects or Fusion Effects applied to a particular clip.

Second, Node Caching

The Node Cache, which is a separate level of caching from the Fusion Output Cache, can be triggered in several different ways, corresponding to the three different purposes it serves.

– When enabled by turning on the Smart Cache, nodes with processor-intensive operations (along with all nodes appearing upstream in that grade’s node tree) are automatically cached, meaning that, for example, if Nodes 1 and 2 are cached, you can continue adjusting Nodes 3, 4, and 5 to your heart’s content without needing to re-render your grade to the cache. Operations that trigger caching include Noise Reduction, Motion Blur, and any Resolve FX or OFX plug-in that’s added to a node. If you’ve added a Resolve FX to a node that’s capable of playing in real time but that node is being flagged for caching anyway, you can force caching off for that node by right-clicking it and choosing Node Cache > Off from the contextual menu.

– You can manually force any node to cache if it and its upstream nodes are compromising performance but somehow not being automatically flagged, by right-clicking a node and choosing Node Cache > On from the contextual menu.

– You can also turn on the “Render Cache Color Output” option for a clip in the Timeline of either the Edit or Color pages. This forces that clip’s entire grade to be cached via the Node Cache, all the way through the Node tree’s output. This can result in higher real time performance in the Edit page, at the expense of needing to completely re-cache that clip whenever you adjust any part of its grade.

– If you apply Resolve FX or OFX filters to clips in the Edit page, these will also be cached via the Node Cache. If necessary, you can choose which OFX to cache via the Render Cache OFX Filter submenu in the contextual menu for clips in the Timeline. This is useful when you have a combination of realtime and non-realtime filters applied to a clip; caching the non-realtime filters only enables you to continue adjusting realtime filters without the need to re-cache. However, be aware that making changes to a filter being cached in the Edit page timeline will force that clip’s grade to be re-cached in the Color page, and vice versa.

If multiple nodes are flagged for caching in a particular node tree, then each node will be individually cached. That way, you can turn a cached node off and on to get a before-and-after look without needing to re-cache the entire node tree. If a clip is part of a group in the Color page, you can enable a Group Cache in the Group Pre-Clip and Group Post-Clip Node Editor modes, which cache these parts of a group grade as part of the Node Cache.

Third, the Sequence Cache

The Sequence Cache is a separate cache for effects that are specifically applied within the Timeline in the Edit page. These include transitions, opacity adjustments, and composite mode superimpositions. Sequence Cache effects can be auto-cached in both the Smart and User caches.
Choosing a Cache Format and Location

The cache format is user selectable by opening the Master Settings panel of the Project Settings, and using the “Render Cache Format” drop-down menu to choose one of the ProRes, DNxHR, or uncompressed 10- or 16-bit float uncompressed .dvcc formats. Selecting a higher quality cache format guarantees high quality image playback, but makes more demands on the throughput and size of your available disk storage. On the other hand, choosing a more highly compressed cache format makes real time playback possible on less capable computers with slower and smaller storage, at the expense of slightly compromised image quality. Ideally, you should choose the highest quality cache format that your workstation’s storage can accommodate.

The format you choose via the “Render Cache Format” menu will determine whether out-of-bounds image data (including “super white” or HDR strength highlights) is preserved when the signal is cached. Formats in this menu that end in “– HDR” preserve out-of-bounds image data, while formats that don’t, won’t. If you find that image data (typically bright highlights) is clipped after caching or optimizing, you should switch to 16-bit float, ProRes 4444, ProRes 4444 XQ, or DNxHR 444; in particular, any of these codecs are appropriate for HDR grading.

The Cache files location defaults to the first volume you add to the Scratch Disks list of the Media Storage panel of the System Preferences. If no scratch disk is specified, your System disk will be used, which may pose problems with capacity and/or performance depending on the size and type of System disk you’re using, and on the media format you choose to cache to. For this reason, it’s nearly always advisable to set your first scratch disk to the largest, fastest storage volume available to your workstation.

When Caching Happens

When caching is enabled, cache indicators along the bottom of the Timeline Ruler of the Edit page timeline shows the status of the cache. Red means “to be cached,” while blue means “has been cached.”

In the Color page, cache indicators are node specific, showing the node in your grading node tree (including all upstream nodes) at which caching will take place.

Caching happens in two ways. First, when either Smart or User caching is enabled, caching always happens whenever you play clips with red caching indicators.

Second, if background caching is enabled in the Project settings (it’s turned on by default), and you don’t make any changes to your project for a user-definable number of seconds (this is adjustable in the Master Settings panel of the Project Settings), caching will automatically begin during periods of user inactivity. So feel free to use this as an excuse to take those coffee, mate, or tea breaks; DaVinci Resolve will keep on working for you.
The Difference Between the Smart Cache and User Cache Modes

The Smart Cache option of the Render Cache submenu provides the easiest user experience when you want to “set it and forget it.” Choosing Smart triggers a variety of automatic caching behaviors designed to optimize playback in DaVinci Resolve by rendering clip formats, grading operations, and timeline effects that are known to be performance-intensive, while also letting you manually flag clips that you’d like to cache that the Smart Cache hasn’t.

The User Cache, on the other hand, does not automatically cache clips in processor-intensive formats, so this is a good option to choose when your workstation is capable of playing all media formats you’re using in real time. Ordinarily, the User cache relies on you to control what is cached and what is not by manually flagging specific clips and effects. However, the Master Settings panel of the Project Settings has three options you can enable for automatically caching transitions, composites, and Fusion Effects while in User Cache mode (these options are found in the Optimized Media and Render Cache group). Of these settings, only “Automatically cache Fusion Effects in User Mode” is turned on by default.

Here are the differences between the Smart and User cache modes for each type of caching DaVinci Resolve does.

Fusion Output Caching

– **In Smart mode:** For all clips with “Render Cache Fusion Output” set to either Auto (by default) or On, three types of effects are rendered. First, H.264, H.265, DCP, JPEG2K, or camera raw clips that have been edited into a timeline are cached. Camera Raw clips are cached using the currently selected project or clip debayer settings. Second, Speed effects are cached at the source level, which makes it possible to move cached speed effects clips on the Timeline without needing to re-cache them. Finally, Fusion Clips or clips with Fusion Effects applied to them are also cached, and manually flagged clips are also cached in Smart mode.

– **In User mode:** Clips with Render Cache Fusion Output set to On are cached, while clips set to Auto are ignored, except for clips with Fusion Effects, which are automatically cached in Auto mode when the “Automatically cache Fusion Effects in User Mode” Project Setting is on.

Caching Specific Nodes in the Color Page

– **In Smart mode:** DaVinci Resolve automatically caches all nodes that use Motion Blur, Noise Reduction, or Resolve FX and OFX plug-ins. Manually flagged nodes are also cached in Smart mode.

– **In User mode:** DaVinci Resolve only caches nodes that have been manually flagged by right-clicking them and choosing Node Cache > On to force that node to cache in User mode, along with all upstream nodes to the left of them.

Cache Color Output Is Actually Node Caching for the Whole Grade

– **In Smart mode:** Manually flagged clips with Render Cache Color Output turned on cache the entire output of the Color page node graph, effectively caching that clip’s entire grade. This is most useful when you want to improve trimming and playback performance in the Edit page. Flagging a clip for caching also causes EVERY SINGLE VERSION associated with that clip to be cached as well.

– **In User mode:** Manually flagged clips with Render Cache Color Output turned on also cache the entire output of the Color page node graph.
Caching of Resolve FX and OFX in the Edit Page Is Also Node Caching

Caching of Resolve FX and OFX filters applied to clips in the Edit page can only be set manually, whether you’re in Smart or User mode. Only filters that you have flagged to cache by right-clicking the clip they’re applied to and choosing them in the Render Cache OFX Filter submenu are cached.

Sequence Caching

– **In Smart mode:** DaVinci Resolve automatically caches all superimposed clips that use composite modes other than “Normal,” any clips with opacity or speed effects, and any transitions. Clips cannot be manually flagged for Sequence caching.

– **In User mode:** If you’ve enabled User mode and you find that your workstation does not have adequate performance to play composite and opacity effects in the Edit page, you can force these categories of effects to be automatically cached in User mode via a set checkboxes in the Optimized Media and Render Cache section of the Master Settings of the Project Settings. When these options are enabled, you also gain the ability to exclude specific tracks from being cached, by right-clicking the track header of any video track you want to exclude from caching, and choosing Exclude track from caching. Excluding an entire track from caching is a convenient way of keeping a track full of effects that are capable of playing in real time on your workstation, such as a track of titles, from wasting time and storage by being cached when it’s not necessary.

Manually Controlling the Cache

This section describes how to manually control each type of caching that is manually controllable in DaVinci Resolve.

Controlling Fusion Output Caching

You can manually control which clips in the Timeline are cached, and which are not. You can select one or more clips in the Timeline of the Edit page, or in the Thumbnail Timeline of the Color page, right-click one of the selected clips or thumbnails, and choose an option from the Render Cache Fusion Output submenu. There are three options:

– **Auto:** The clip will only be cached in Smart mode if it’s a format designated for caching or if there’s a speed effect applied. The clip will only be cached in User Mode if “Automatically cache transitions in User Mode” is enabled.

– **On:** The clip will be cached in either Smart or User mode, no matter what format or effects are applied.

– **Off:** The clip will not be cached at all, in either Smart or User modes.

Controlling Node Caching

You can manually control which nodes in a grade are cached, and which are not. Right-click any node in a node tree, and choose an option from the Node Cache submenu. There are three options:

– **Auto:** The flagged node and all upstream nodes will only be cached in Smart mode if it contains an operation that’s designated for caching.

– **On:** The node will always be cached in either Smart or User mode, no matter what operations it performs.

– **Off:** The node will not be cached, in either Smart or User modes. This lets you exclude nodes from caching in Smart mode if they’re capable of real time operation on your system.
Controlling Color Output Caching

Each clip in the Timeline (including Adjustment clips) has a Color Output setting that you can turn on or off by right-clicking that clip in the Timeline of the Edit page, and choosing Render Cache Color Output from the contextual menu. A check mark indicates when this setting is turned on.

Controlling Edit Page Filter Caching

You can choose which of the Resolve FX or OFX filters applied to a particular clip should be cached by right-clicking that clip in the Timeline of the Edit page, and choosing which of the filters in the Render Cache OFX Filter submenu you want to cache.

Each filter applied to that clip appears in this submenu in the order in which it’s applied to the clip, and you can turn the caching of specific filters on and off (selected filters appear with a check mark to the left of their menu item).

Clearing Cached Media

Each project’s cache is persistent; the cache is saved for future use even when the project is closed and later reopened. If you need to delete a project’s cache to free up space on a storage volume, there are three options in the Delete Render Cache submenu:

- **All**: You can delete all media in the cache to reset every single cached clip.
- **Unused**: You can choose to delete only Unused cache clips that no longer correspond to clips or effects in the Timeline.
- **Selected clips**: You can make a manual selection of clips in the Timeline, and delete the cache corresponding to just those clips.

To clear a project’s cache:

Open the project, and choose Playback > Delete Render Cache > All, Unused, or Selected Clips.

Using Cached Media When Rendering in the Deliver Page

The “Use Render Cached Images” option in the “More options” section of the Video panel of the Render Settings in the Deliver page lets you write media directly from the cache, rather than re-rendering the effects from scratch, in order to save rendering time when you output your project. If you’re planning on using this option, it’s advisable to set the cache format to a suitably high-quality format to guarantee the best results.

Using Proxy Media

DaVinci Resolve includes a Proxy Media workflow to provide a playback optimization option that makes it easier to exchange projects online, work on projects remotely, and work with external media asset management systems. It creates a simple and flexible system for editing collaboration that can be custom configured to your specific requirements.

Creating and Using Proxy Media

Proxy Media is essentially more highly compressed (and potentially lower resolution) versions of your source media that are linked to your source media in DaVinci Resolve via metadata. This is done in such a way as to make it easy to switch back and forth between the original and proxy media as your needs require.
Typically, this lets you use lower bandwidth proxy media for increased real-time effects performance and full speed playback while editing, while easily reverting back to more bandwidth and processor-intensive source media for color correction, finishing, and final output. In addition to enabling better performance, these proxy files are fully portable, which lets you move your whole project easily from workstation to workstation, and even across the internet, accompanied by much more compact proxy media.

You set the resolution and format of your proxies in the Optimized Media and Render Cache section of the Master Settings panel in the Project Settings. There are two settings that control the actual media files created by the Generate Proxy Media command.

- **Proxy Media Resolution**: Choose “Original” to keep proxies the same resolution as the source media. If you prefer, reduce the resolution of the proxy media files by choosing Half, Quarter, Eighth, or Sixteenth to save bandwidth. The “Choose Automatically” option balances visual quality with efficiency by only reducing the resolution of media files that are larger than the currently selected Timeline resolution, using whatever reduction ratio best matches the Timeline resolution.

- **Proxy Media Format**: Lets you choose the specific QuickTime format and codec that the proxy files will be created with. There are several ProRes and DNxHR varieties to choose from, as well as H.264 and H.265 options. Which format you chose will be determined by the bandwidth and quality tradeoffs that you need for a particular project. For example, if you simply want better playback speed from RAW media while preserving image quality, you may want to pick a high-quality codec like ProRes 422 HQ, or DNxHR HQX. If your goal is to send your media across the internet to another editor, you may want to chose a more compressed format, such as ProRes Proxy, or even H.264 or H.265, to keep file sizes small.

The Proxy Media Resolution and Format settings

### To generate proxy media in DaVinci Resolve:

1. Select all of the clips you wish to generate proxies for in the Media Pool.
2. Right-Click any selected clip and choose “Generate Proxy Media” from the contextual menu.

DaVinci Resolve will display a progress bar and give you a time estimate for completion as it renders out your selected clips to the format and codec determined by the Proxy Media Resolution and Format settings.

**NOTE:** If your source clip has a separate audio file synced to it in the Media Pool, any proxies generated from that clip will include the synced audio, but that audio will be embedded in the video clip instead of being created as a separate file.

### Where is Proxy Media Saved?

Proxy media is created in the “Proxy generation location” destination, found in the Working Folders section of the Master Settings of the Project Settings. The proxies are further organized into subfolders by original source clip location. It is important to have enough free space on this drive to contain the proxies. Once created, these proxy files can then be moved to any other drive location on the system, if you wish, and then re-linked to their source files.
Generating Proxy Media in Other Applications

Proxy files can also be generated in applications outside of DaVinci Resolve, such as other NLEs or various media asset management systems. To properly link the proxy to its source media in DaVinci Resolve, the proxy file must meet the following criteria:

– Proxy files must have identical timecode to the source file.
– Proxy files must have the same file name as the source file (excluding extensions).
– Proxy files must have the same frame rate as the source file.
– The format and codec used for proxy files must be supported in DaVinci Resolve.

If your proxy file meets these criteria, you’ll be able to manually link proxy media created in other applications to source clips in the Media Pool as described below.

Managing Proxy Media

You can check the status and location of all your proxy media in the List view of the Media Pool. Right-click on any column heading and click the checkboxes of “Proxy” and “Proxy Media Path.”

– **Proxy**: This column shows the current proxy status.
  – **None**: Indicates no proxy media has been created.
  – **Offline**: Indicates a proxy has been created but cannot be found in the Proxy Media path.
  – (Resolution): A number indicating the resolution of the created proxy and that it is online.

– **Proxy Media Path**: The location of where DaVinci Resolve is looking for the proxy file. If this location is incorrect, you can relink the proxy to a new path manually.

The proxy columns in List view, showing Proxy Media status and location

Linking Clips to Proxy Media

If you’ve created proxy media in another application, or moved the internally created proxy media out of its default location in “ProxyMedia,” you’ll need to manually link the proxies to their source media files in your Media Pool.

**To link proxy media to a source clip:**

1. Select one or more clips in the Media Pool you wish to link proxy media to.
2. Right-click one of the selected clips, and choose “Link Proxy Media” from the contextual menu.
3. Use the file browser to find the specific proxy file or directory (in the case of multiple clips) to set a new Proxy Media path, and click Open. If you select an incorrect file or directory, a warning dialog box will appear and no linking will occur.
To unlink proxy media from a source clip:
1. Select a clip or clips in the Media Pool you wish to unlink proxy media from.
2. Right-click on any clip and select “Unlink Proxy Media” from the contextual menu. This will remove the metadata link from proxy to source and will set the status in the Proxy column to “None.”

**NOTE:** Unlinking a proxy file does not delete it. The proxy file remains on the hard drive where it was created. As of this writing, proxy files must be deleted manually using your OS file system outside of DaVinci Resolve.

Re-generating Proxy Media
You can generate more than one proxy file per clip. This can be useful if you want to set multiple Camera Raw parameters and choose between them, or to create proxy files of different resolutions.

To generate a new proxy:
1. Make your desired changes to the current clip’s settings.
2. Right-click on the same clip and select “Generate Proxy Media” from the contextual menu.

A new proxy file is created in the same directory as the previously linked proxy file, and its file name is appended with “_s00x” to differentiate it. The latest proxy generated is automatically linked to the source file, but previous proxy versions are retained on disk, so you can then manually relink the different versions as needed.

Switching Between Proxy Media and Source Media
You can switch between using your original source media and the proxy media for playback at any time by checking or unchecking Playback > Use Proxy Media If Available in the Menu bar.

Using Proxy Files for Delivery
By default, the Deliver page always reverts proxies to the original source media for final output to ensure the highest quality render. Checking the “Use proxy media” box in the Advanced Settings of the Video Render settings in the Deliver page overrides this so DaVinci Resolve uses proxy media for final output instead. This can be useful if you need to save rendering time while making dailies, or to quickly create outputs of your timeline for producers or audio engineers where master quality is not necessarily needed. You will also need to check the “Use proxy media” box if you are editing with proxies and do not have access to the original source media.

Moving Proxies Using a DaVinci Resolve Archive (.dra)
When moving proxies from one DaVinci Resolve system to another, it can be time consuming and problematic to manually copy many individual assets (proxies, graphics, source files, etc.) from different folders and locations. By far the easiest way to move complete projects from system to system is by letting DaVinci Resolve do all that file management for you, by creating a DaVinci Resolve Archive (.dra). An archive file contains not only your project, but all its media as well, maintaining the file paths and organization of the original project.

To create a DaVinci Resolve Archive file, right-click on any project in the Project Manager, and choose “Export Project Archive” from the drop-down menu. Within this mechanism, a new Archive setting in DaVinci Resolve makes working with proxies simple and elegant.
Creating a Proxy-Only Archive to Share

In the Archive Options dialog, if you check Proxy Media, and uncheck Media Files and Render Cache, DaVinci Resolve will make an Archive using only the proxy media. This allows you to create a compact and easily transported version of your project to either move to another computer, or to give to an editor working remotely. If proxy media is not available for a clip (say a graphic or a media file you didn’t create a proxy for in the first place), the original media is automatically exported to ensure that nothing goes offline.

The resulting .dra is a folder that is a fully self-contained version of your project and proxy media. This folder can easily be moved from drive to drive, or zipped up and sent across the internet.

Working Remotely Using Proxy Media

The proxy workflow in DaVinci Resolve opens up many new possibilities for editing collaboration and media management. For example, one common workflow is to use the RAW camera master source clips in the editing suite but to then generate low resolution proxies to take home to edit on a laptop.

To create a portable set of proxies for editing on a laptop:

1. Set up the Resolution and Format settings for the proxies in the Project Settings. In this case, you may want to use “Choose Automatically” and a low-bandwidth, easily editable codec like ProRes LT or DNxHR LB.
2. Select all source media in the Media Pool and Generate Proxy.
3. Export a DaVinci Resolve Archive (.dra) onto an external drive, with only Proxy Media checked.
4. Go away. Once at home, connect that drive to your home laptop, and use the Restore Project Archive command in the Project Manager to import the archive.
5. When you’ve finished working at home, export a timeline, bin, or project from your laptop when finished, and bring just that file back into the edit suite to continue working with the original source media.

Another common scenario might involve sending proxies over the internet to an editor in another city or country.

To send a project to another editor over the internet:

1. Set up the Resolution and Format settings for the proxies in the Project Settings. In this case, you may want to use a low resolution like “quarter” or “one-eighth,” and a low-bandwidth, highly-compressed codec like H.265 for the smallest file sizes possible.
2. Select all of the source media in the Media Pool and Generate Proxy.
3. Export a DaVinci Resolve Archive (.dra), with only Proxy Media checked.
4. Using the file compression tools in your OS, zip the archive folder so it becomes one large file.
5 Upload the resulting .zip to the online file sharing service you prefer, and send the download link to the remote editor.

6 Once the other editor unzips and imports the archive, you and they can then simply send timelines, bins, and/or project files back and forth to collaborate. These files are small enough to transfer over email or an instant messaging service.

Additionally, you may have your editing computer connected via ethernet to a Media Asset Management system that can create its own proxies. In order to edit smoothly via the network, you need to use low bandwidth proxies instead of the source media.

To create proxy media externally to edit over a local network:

1 Import the original source media files to your Media Pool from the network storage system you’re using.

2 Set up the proxy generation settings in your Media Asset Management software to accommodate the amount of network bandwidth you expect to have access to.

3 Make sure the timecode and frame rate of the proxies match the original source media, and render the proxies to a network location.

4 Select all of your original source media in the Media Pool, and choose “Link Proxy Media.”

5 Choose the proxy media at the network location where they’ve been rendered.

Proxy Media vs. Other Playback Optimizations in DaVinci Resolve

There continue to be other methods of optimizing real time performance in DaVinci Resolve, so it’s natural that one might wonder how this is different from Optimized media, Timeline Proxy Mode, and other performance optimization techniques available in DaVinci Resolve. The key aspect of proxy media that differentiates it is that proxy media is independent, portable, and can be created by applications outside of DaVinci Resolve, if desired.

Proxy Media vs. Timeline Proxy Mode

One of the oldest performance optimization options, originally named “Proxy Mode” in previous versions of DaVinci Resolve, has been renamed “Timeline Proxy Mode” in DaVinci Resolve 17 to differentiate it from Proxy Media. While the new Proxy Media feature creates actual media files on disk, “Timeline Proxy Mode” simply reduces the resolution of the timeline on-the-fly, allowing for increased real time playback performance. To be clear, Proxy Media and Timeline Proxy Mode are two entirely different features, which are wholly independent of one another.

Proxy Media vs. the Render Cache

Proxy Media is designed to create easy-to-edit primary source material on the Timeline, for improved performance before you start editing. The Render Cache is designed to improve the real time performance of clips that have enough computationally intensive effects (such as Resolve FX, color corrections, noise reduction, compound clips, fusion compositions, etc.) to slow playback, even at the current Timeline resolution. Proxy Media is independent and portable (you can move clips wherever you want; you just have to relink them afterward), while the Render Cache media is not designed to be moved or interacted with externally and only works with the project it was made for.
Proxy Media vs. Optimized Media

On the surface, Proxy Media and Optimized Media appear similar in function. Both options are designed to create lower bandwidth, easier to edit versions of source media. However, Optimized Media is managed internally by DaVinci Resolve, cannot be exported, and is not user accessible. In contrast, Proxy Media creates fully portable and independent media that can be easily managed by the user.

Using Optimized Media, Proxy Media, and Caching Together

How you use DaVinci Resolve’s various performance-enhancing features together is entirely up to you, but you should know that they’re not an either/or proposition. For example, you can create optimized media from the camera raw original clips in your project, then enable Timeline Proxy Mode playback to enhance the performance of your 4K timeline, and turn on Smart Cache to speed up your work in the Color page as you add Fusion effects, noise reduction, and Resolve FX or OFX to every clip. All of these optimization methods work happily and seamlessly together to improve your performance while keeping the image quality of your project as high as the Optimized, Proxy, and Cache formats you’ve selected in the Master Settings panel of the Project Settings.

Which Playback Optimization Method Should I Use?

DaVinci Resolve’s various playback optimization features are designed to specifically increase performance to make up for hardware, storage, and bandwidth deficiencies, but knowing when to use each method is essential to proper functionality. Included below is a quick reference.

- **Timeline Proxy Mode**: My timeline is playing back, just a little bit too slowly.
- **Cache Clip**: I need help playing back a few clips in real time that have heavy effects applied.
- **Optimized Media**: I need help playing back all my source media in real time, and I will only be editing on this computer.
- **Proxy Media**: I need help playing back all my source media in real time, and I need to collaborate and share this media with other users, programs, or outside storage locations.

Other Project Settings That Improve Performance

In addition to working with proxies, using reduced raw decoding quality, generating optimized media, and enabling the Smart and User caches, there are five additional options in the Project Settings window and one setting in the UI Settings panel of the User Preferences that you can use to further improve real time performance if you’re working on an underpowered computer, at the expense of lower image quality while you work. These settings can then be changed back to higher quality modes prior to rendering.
– **Set timeline resolution to:** (Master Project Settings, Timeline Format) DaVinci Resolve is resolution independent, so you can change the resolution at any time and all windows, tracks, sizing changes, and keyframe data will be automatically recalculated to fit the new size. Lowering the Timeline resolution while you’re grading will improve real time performance by reducing the amount of data being processed, but you’ll want to increase Timeline resolution to the desired size prior to rendering. This is effectively the same as using the Proxy command, but you get to choose exactly what resolution you want to work at.

– **Enable video field processing:** (Master Project Settings, Timeline Format) You can leave this option turned off even if you’re working on interlaced material to improve real time performance. When you’re finished, you can turn this setting back on prior to rendering. However, whether or not it’s necessary to turn field processing on depends on what kinds of corrections you’re making. If you’re applying any filtering or sizing operations such as blur, sharpen, pan, tilt, zoom, or rotate, then field processing should be on for rendering. If you’re only applying adjustments to color and contrast, field processing is not necessary.

– **Video bit depth:** (Master Project Settings, Video Monitoring) Monitoring at 8-bit improves real time performance, at the expense of possibly introducing banding to the monitored image.

– **Monitor scaling:** (Master Project Settings, Video Monitoring) Lets you choose which transform filter to use when scaling video to fit into the Video format resolution you’ve specified. Options are Bilinear and Basic.

– **Resize Filter:** (Image Scaling) A drop-down menu that lets you choose an alternate image transform filter (such as Bilinear) that is lower quality but less processor intensive. A “Force sizing highest quality” checkbox in the Render Settings list of the Deliver page helps make sure you don’t accidentally render your final media at this lower quality setting, however.

– **Hide UI overlays:** (User Preferences, Playback Settings) Off by default. When using a single GPU for both display and CUDA or OpenCL processing, or if your display GPU is underpowered, or if you lack the PCIe bandwidth required for the currently specified resolution or frame rate, you may be able to improve real time performance by turning this option on. When enabled, onscreen controls such as the cursor, Power Window outlines, and split-screen views are disabled and hidden during playback. When playback is paused, all onscreen controls reappear.

– **Minimize interface updates during playback:** (User Preferences, Playback Settings) On by default. While enabled, this setting improves real time performance by hiding on-screen controls that appear in the Viewer, such as the cursor, Power Window outlines, and split-screen views during playback. When playback is stopped, onscreen controls reappear.
Chapter 8

Data Levels, Color Management, and ACES

This chapter covers operational details that affect how color is managed for media that is imported into and exported from DaVinci Resolve. If color accuracy is important to you, then it’s a good idea to learn more about how Resolve handles the data levels of each clip, how DaVinci Resolve Color Management helps you to work with different formats, and how to use ACES.

Contents

Data Levels Settings and Conversions 181
Converting Between Ranges and Clipping 182
Internal Image Processing and Clip Data Levels 182
Assigning Clip Levels in the Media Pool 183
Video Monitoring Data Levels 183
Deck Capture and Playback Data Level 184
Output Data Level Settings in the Deliver Page 184
So, What’s the “Proper” Data Range for Output? 185
Introduction to DaVinci Resolve Color Management 185
Display Referred vs. Scene Referred Color Management 185
Updated RCM In DaVinci Resolve 17 186
Resolve Color Management for Editors 186
The Input, Timeline, and Output Color Space 187
The RCM Image Processing Pipeline 188
Identifying the Input Color Space of Different Clips 188
Simple RCM Setup 190
Different media formats use different ranges of values to represent image data. Since these data formats often correspond to different output workflows (cinema vs. broadcast), it helps to know where your project’s media files are coming from, and where they’re going, in order to define the various data range settings in DaVinci Resolve and preserve your program’s data integrity.

To generalize, with 10-bit image values (with a numeric range of 0–1023), there are two different data levels (or ranges) that can be used to store image data when writing to media file formats such as QuickTime, MXF, or DPX. These ranges are:

- **Video**: Typically used by Y’CBCR video data. All image data from 0 to 100 percent must fit into the numeric range of 64–940. Specifically, the Y’ component’s range is 64–940, while the numeric range of the CB and CR components is 64–960. The lower range of 4–63 is reserved for “blacker-than-black,” and the higher ranges of 941/961–1019 are reserved for “super-white.” These “out of bounds” ranges are recorded in source media as undershoots and overshoots, but they’re not acceptable for broadcast output.

- **Full**: Typical for RGB 444 data acquired from digital cinema cameras, or film scanned to DPX image sequences. All image data from 0 to 100 percent is simply fit into the full numeric range of 4 to 1023.
Keep in mind that every digital image, no matter what its format, has absolute minimum and maximum levels, referred to in this section as 0–100 percent. Whenever media using one data range is converted into another data range, each color component’s minimum and maximum data levels are remapped so that the old minimum value is scaled to the new data level minimum, and the old maximum value is scaled to the new data level maximum:

- (minimum Video Level) 64 = 4 (Data Level minimum)
- (maximum Video Level) 940 or 960 = 1023 (Data Level maximum)

**Converting Between Ranges and Clipping**

Simply converting an image from one data range to another should result in a seamless change. All “legal” data from 0–100 percent is always preserved and is linearly scaled from the previous data range to fit into the new data range.

The exceptions to this are undershoots and overshoots that you’ve deliberately set, also referred to as out-of-bounds levels. The overshoots and undershoots that are allowable in “Video Levels” media (known as sub-black or super-black and super-white) are usually clipped when converted to full-range “Full Levels.” However, DaVinci Resolve preserves this data internally, and these clipped pixels of detail in the undershoots and overshoots are still retrievable by making suitable adjustments in the Color page to bring them back into the “legal” range.

The out-of-bounds image data that’s preserved within the headroom of Video Levels by DaVinci Resolve while working is usually clipped, however, when you either output to video or render your output. There are two settings that let you get around this for instances where you want to preserve these levels:

- A checkbox in the Video Monitoring group of the Master settings, “Retain sub-black and super-white data,” lets DaVinci Resolve output undershoots (sub-black) and overshoots (super-white) to video when Data Level is set to Video. When this is turned off, these out-of-bounds values are clipped on output.
- A checkbox in the Advanced settings of the Render settings in the Deliver page, “Retain sub-black and super-white data,” lets DaVinci Resolve render undershoots (sub-black) and overshoots (super-white) to exported media when Data Level is set to Video.

**Internal Image Processing and Clip Data Levels**

It’s useful to know that, internally to DaVinci Resolve, all image data is processed as full range, uncompressed, 32-bit floating point data. What this means is that each clip in the Media Pool, whatever its original bit-depth or data range, is scaled into full-range 32-bit data. How each clip is scaled depends on its Levels setting in the Clip Attributes window, available from the Media Pool contextual menu.

![Data Levels](image)

Selecting Auto, Video, or Full levels

By converting all clips to uncompressed, full-range, 32-bit floating point data, Resolve guarantees the highest quality image processing that’s possible. As always, the quality of your output is dependent on the quality of the source media you’re using, but you can be sure that Resolve is preserving all the data that was present in the original media.
Assigning Clip Levels in the Media Pool

When you first import media into the Media Pool, either manually in the Media page or automatically by importing an AAF or XML project in the Edit page, Resolve automatically assigns the “Auto” Levels setting. When a clip is set to Auto, the Levels setting used is determined based on the codec of the source media.

DaVinci Resolve generally does a good job of figuring out the appropriate Levels setting of each clip on its own. However, in certain circumstances, such as when you’re working with media that was originated in one format but transcoded into another, you may find that you need to manually choose the appropriate settings so that the levels of each clip are interpreted correctly. This can be done using each clip’s Levels setting in the Clip Attributes window, available from the Media Pool contextual menu in either the Media or Edit pages.

To change a clip’s Data Level setting:
1. Open the Media or Edit page.
2. Select one or more clips, then right-click one of them and choose Clip Attributes.
3. Click the Levels ratio button corresponding to the data level setting you want to assign, then click OK.

**TIP:** If you need to change the Levels setting of a range of clips that share a unique property such as reel name, resolution, frame rate, or file path, you can view the Media Pool by column, and sort by the particular column that will best isolate the range of media to which you need to make a data level assignment.

Once you change a clip’s Levels setting, that clip will automatically be reconverted based on the new assignment. If it appears to be correct, then you’re ready to work. If it doesn’t, then you may want to reconsider the Levels assignment you’ve made, and you should check with the person who provided the media to find out how it was generated, captured, and exported.

So long as the Levels settings used by your clips are accurate, you should be ready to work. However, problems can still occur based on what external video hardware you’re using with your workstation, and how you need to deliver the finished media to your client. For this reason, there are three additional data level settings that you can use to maintain data integrity, while at the same time seeing the proper image as you work.

**Video Monitoring Data Levels**

Superficial problems may result if the settings used by your external display differ from the settings you’re using to process data levels in Resolve. Accordingly, there is a Video/Full Level setting in the Master Settings panel of the Project Settings (in the Video Monitoring section).

When you change this setting, the image being output to your external display should change, but the image you see in your Viewer will not. That’s because this setting only affects the data levels being output via the video interface connecting the Resolve workstation to your external display. It has no effect on the data that’s processed internally by Resolve, or on the files written when you render in the Deliver page.

There are two options:
- **Video:** This is the correct option to use when using a broadcast display set to the Rec. 709 video standard (10-bit 64–940).
- **Full:** If your monitor or projector is capable of displaying “full range” video signals, and you wish to monitor the full 10-bit data range (4–1023) while you work, then this is the correct option to use.
It is imperative that the option you choose in DaVinci Resolve matches the data range the external display is set to. Otherwise, the video signal will appear to be incorrect, even though the internal data is being processed accurately by DaVinci Resolve.

**Deck Capture and Playback Data Level**

There is a separate “Video/Data Level” setting that is specific to when you’re capturing from or outputting to VTRs. This setting also affects the video signal that is output via the video interface connecting the Resolve workstation to your VTR (which is usually also in the signal chain used for monitoring). However, it only takes effect when you’re capturing from tape in the Media page, or editing to tape in the Deliver page. If you never capture or output to tape, this setting will never take effect.

This setting is found in the Deck Capture and Playback panel of the Project Settings.

The reason for a separate option for tape capture and output is that often you’d want to monitor in one format (normally scaled Rec. 709), but output to tape in another (full range RGB 444). This way, you can set up Resolve to accommodate this workflow, and then not have to worry about manually switching your video interface back and forth.

There are two options:

- **Video**: This is the correct option to use when you want to output conventional Rec. 709 video to a compatible tape format.
- **Full**: This is the correct option to use when you want to output “full range” RGB 444 video to a compatible tape format.

Once tape ingest or output has finished, your video interface goes back to outputting using the setting specified by the “Colorspace conversion uses” setting in the Master Settings panel of the Project Settings (in the Video Monitoring section).

**Output Data Level Settings in the Deliver Page**

Finally, there’s one last set of data level settings, available in the Render Settings list, within the Format group. It’s the “Set to video or data level” drop-down menu. It’s there to give you the ability to convert the data level of your rendered output, if necessary.

All media is output using a single data level, depending on your selection. There are three options:

- **Automatic**: The output data level of all clips is set automatically based on the codec you select to render to in the “Render to” drop-down menu.
- **Video**: All clips are rendered as normally scaled for video (10-bit 64–940).
- **Full**: All clips are rendered as full range (10-bit 4–1019).

For most projects, leaving this setting on “Automatic” will yield the appropriate results. However, if you’re rendering media for use by another image processing application (such as a compositing application) that is capable of handling “full range” data, then full range output is preferable for media exchange as it provides the greatest data fidelity. For example, when outputting media for VFX work as a DPX image sequence, or as a ProRes 4444 encoded QuickTime file, choosing “Unscaled full range data” guarantees the maximum available image quality. However, it is essential that the application you use to process this media is set to read it as “full range” data, otherwise the images will not look correct.
So, What’s the “Proper” Data Range for Output?

Strictly speaking, there is no absolutely “proper” data range to use when outputting image data. As long as the Levels setting of each clip in the Media Pool is set to reflect how each clip was created, your primary consideration is which data range is compatible with the media format or application you’re delivering to. If the media format you’re exporting to supports either normally scaled or full range, and the application that media will be imported into supports either normally scaled or full range, then it’s really your choice, as long as everyone involved with the project understands how the data range of the media is meant to be interpreted once they receive it.

Outputting to hardware is a bit trickier, in that you need to make sure that the external display or VTR you’re outputting to is set up to receive a signal using the data range you’ve chosen. If the device is limited to only one data range, then you need to be sure that you’re outputting to it using that data range, or the levels of the image will appear to be incorrect, even though the image data being processed by Resolve is actually fine.

Introduction to DaVinci Resolve
Color Management

How color is managed in DaVinci Resolve depends on the “Color Science” setting at the top of the Color Management panel of the Project Settings. There are four options: DaVinci YRGB, DaVinci YRGB Color Managed, DaVinci ACEScc, and DaVinci ACEScct. This section discusses the second setting, DaVinci YRGB Color Managed. ACEScc and ACEScct is discussed in the following section in this chapter.

Display Referred vs. Scene Referred Color Management

The default DaVinci YRGB color science setting, which is what DaVinci Resolve has always used, relies on what is called “Display Referred” color management. This means that Resolve has no information about how the source media used in the Timeline is supposed to look; you can only judge color accuracy via the calibrated broadcast display you’re outputting to. Essentially, you are the color management, in conjunction with a trustworthy broadcast display that’s been calibrated to ensure accuracy.

DaVinci Resolve 12 introduced a color science option called “DaVinci YRGB Color Managed,” or more simply “Resolve Color Management” (RCM). This introduced a so-called “Scene Referred” color management scheme, in which you have the option of matching each type of media you’ve imported into your project with a color profile that informs DaVinci Resolve how to represent each specific color from each clip’s native color space within the common working color space of the timeline in which you’re editing, grading, and finishing.

This is important, because two clips that contain the same RGB value for a given pixel may in actuality be representing different colors at that pixel, depending on the color space that was originally associated with each captured clip. This is the case when you compare raw clips shot with different cameras made by different manufacturers, and it’s especially true if you compare clips recorded using the differing log-encoded color spaces that are unique to each camera.

This Scene Referred component of color management via RCM doesn’t do your grading for you, but it does try to ensure that the color and contrast from each different media format you’ve imported into your project are represented accurately in your timeline. For example, if you use two different manufacturer’s cameras to shoot green trees, recording Blackmagic Film color space on one, and recording to the Sony Sgamut3.Cine/SLog3 color space on the other, you can now use RCM to make sure that the green of the trees in one set of clips match the green of the trees in the other, within the shared color space of the Timeline.

It should be mentioned that this sort of thing can also be done manually in a more conventional Display Referred workflow, by assigning LUTs that are specific to each type of media, or using Color
Space Transform Resolve FX in order to transform each clip from the source color space to the destination color space that you require. However, RCM’s automation can make this process faster by freeing you from the need to locate and maintain a large number of LUTs to accommodate your various workflows. Also, the matrix math used by RCM (as well as the Color Space Transform operation) extracts high-precision, wide-latitude image data from each supported camera format, preserving high-quality image data from acquisition, through editing, color grading, and output. These are all advantages when compared to lookup tables, which can have plenty of precision, but can clip out-of-bounds image data and introduce issues when differing lookup table interpolation methods cause minor inconsistencies with color space transformations from application to application.

The preservation of wide-latitude image data deserves elaboration. LUTs clip image detail that goes outside of the numeric range they’re designed to handle, so this often requires the colorist to make a pre-LUT adjustment to “pull back” image data in the highlights that you want to retrieve. Using RCM eliminates this two-step process, since the input color space matrix operations used to transform the source preserves all wide-latitude image data, making highlights easily retrievable without any extra steps.

Updated RCM In DaVinci Resolve 17

In version 17, DaVinci Resolve introduced the biggest improvements to Resolve Color Management (RCM) since it was originally introduced, adding numerous features to simplify setup, improve image quality, and make the “feel” of your grading controls more consistent. Specific improvements include improved metadata management for incoming media files that support color metadata, a new wide gamut color space suitable for using as your default Timeline working color space for any program, a new Input Tone Mapping option (Input DRT) that makes it easier to mix media formats for SDR and HDR grading, improved Timeline to Output Tone Mapping (Output DRT) that offers improved shadow and highlight handling, and select color space-aware grading palettes that make controls feel and perform well no matter what you’re grading.

This updated Resolve Color Management has the same name as the previous version. However, older projects using the previous version of RCM will have Color science set to Legacy, to preserve the older color management settings and color transformations effect on your work. For more information on how the previous generation of RCM works, see the September 2020 version of the DaVinci Resolve 16 Manual.

How Is DaVinci Resolve Color Management Different from ACES?

This is a common question, but the answer is pretty simple. Resolve Color Management (RCM) and ACES are both Scene Referred color management schemes designed to solve the same problem. However, if you’re not in a specific ACES-driven cinema workflow, DaVinci Resolve Color Management can be simpler to use, and will give you all of the benefits of color management, while approximating the “feel” that the DaVinci Resolve Color page controls have always had.

Resolve Color Management for Editors

RCM isn’t just for Colorists. RCM can be easier for editors to use in situations where the source material is log-encoded. Log-encoded media preserves highlight and shadow detail, which is great for grading and finishing, but it looks flat and unpleasant, which is terrible for editing.

Even if you have no idea how to do color correction, it’s simple to turn RCM on in the Color Management panel of the Project Settings, and then use the Media Pool to assign the particular Input Color Space that corresponds to the source clips from each camera. Once that’s done, each log-encoded clip is automatically normalized to the default Timeline Color Space of Rec. 709 Gamma 2.4. So, without even having to open the Color page, editors can be working with pleasantly normalized clips in the Edit page.
The Input, Timeline, and Output Color Space

The foundation of Resolve Color Management rests on three core settings. Not only do you have the ability to either automatically or manually identify the color science of each individual source clip (the Input Color Space), but you also have explicit control over the working color space within which all color adjustments and operations are made (the Timeline Color Space), and you have separate control over the Output Color Space that defines how your graded image will be monitored and output.

This means that, basically, Resolve Color Management consists of two color transforms working together, converting each source clip via its Input Color Space definition into the Timeline Color Space in which you work, and then converting the adjusted image from the Timeline Color Space to whatever Output Color Space you require to deliver the project.

Resolve Color Management consists of three color transforms working together.

This means that, as a colorist, you can set the Timeline Color Space that you’re working in to whatever you prefer. If you prefer grading wide-gamut log media because you like the way the grading controls behave in that color space, you can set the Timeline Color Space in the Color Management panel of the Project Settings to DaVinci Wide Gamut (more on this below), or any of the available log formats, including ARRI Log C, REDWideGamutRGB/Log3G10, and Cineon Film Log. If you instead prefer grading in the Rec. 709 color space because you’re mastering a standard dynamic range (SDR) program to Rec. 709 and you’re more comfortable with how the controls in DaVinci Resolve have always felt in that color space, you can choose that instead. Whatever Timeline Color Space you assign is what all source clips will be transformed to for purposes of making grading adjustments in the Color page, so you can make this choice using a single setting.

A key benefit of the color space conversions that RCM applies is that no image data is ever clipped during the Input to Timeline color space conversion. For example, even if your source is log-encoded or in a camera raw format, grading with a Rec. 709 Timeline Color Space does nothing to clip or otherwise limit the image data available to the RCM image processing pipeline. All image values greater than 1.0 or less than 0.0 are preserved and made available to the next stage of RCM processing, the Timeline to Output color space conversion.

Consequently, if you’re grading in a color space other than the one you need to output to, you don’t have to worry about data loss during the color transformation back to the color space you actually want to output to. The Output Color Space setting gives you the freedom to work using whatever Timeline Color Space you like while grading, with Resolve automatically converting your output to the specific color space you want to monitor with and deliver to. And thanks to the precision of the image processing in DaVinci Resolve, you can convert from a larger color space to a smaller one and back again without clipping or a loss of quality. Of course, if you apply a LUT or use Soft Clip within a grade, then clipping will occur, but that’s a consequence of using those particular operations.
Finally, it is the Output Color Space that determines the final color space of your rendered result. While no image data is clipped during the Source to Timeline color space conversion, image data will be clipped during the Timeline to Output color space conversion in order for the final image to conform to the color space being rendered and output, unless you use the Gamut Mapping options to compress image data during the Timeline to Output Color Space conversion.

The RCM Image Processing Pipeline

The previous explanation is, of course, simplified. To clarify the inner workings of Resolve Color Management for advanced users, the following flowchart presents a rudimentary overview of how every parameter works together to automatically manage the color of clips in your program.

Identifying the Input Color Space of Different Clips

Central to the process of automated color management is knowing the color space and transfer function used by every clip of source media in your project. There are a variety of ways DaVinci Resolve can figure this out, in a cascading decision-tree that can be manually overridden if necessary. Deriving the Input Color Space involved the following stages of automated decision making:

1. If the source media is a camera raw format like .braw, .R3D, .ari, etc., DaVinci Resolve uses manufacturer-supplied colorimetry to automatically debayer the clip and identify its Input Color Space.

2. Otherwise, if the source media has embedded color space metadata (QuickTime or .MXF make this possible), then use that to identify the Input Color Space.

3. Otherwise, if there is no embedded color space metadata, use the default Input Color Space setting of the Project Settings to assign an Input Color Space to all otherwise unidentified clips.

4. If necessary, you can manually set the Input Color Space of clips in the Media Pool, which overrides both embedded color space metadata (in case it's wrong), or the default Input Color Space setting (if you're dealing with multiple color spaces). You cannot override the Input Color Space of camera raw media.

The following sections discuss each of these steps in more detail.
Using Camera Raw Formats
When you use RCM in a project that uses Camera Raw formats, color science data from each camera manufacturer is used to debayer each camera raw file to specific color primaries with linear gamma, so that all image data from the source is preserved and made available to DaVinci Resolve’s color managed image processing pipeline. As a result, the Camera Raw project settings and Camera Raw palette of the Color page are disabled, because RCM now controls the debayering of all camera raw clips, and all image data from the raw file is available no matter which Timeline Color Space you choose to work within.

Using Source Media Color Space Metadata
When enabled, RCM automatically identifies the color space information of imported media that’s been either transcoded or recorded directly to supported non-raw media formats, reading the NCLC metadata of QuickTime-wrapped files, the color space metadata of .mxf-wrapped files, and the XML sidecar files that track color management in ACES workflows. This behavior is automatic; there are no visible controls governing this behavior aside from the individual Input Color Space and Input Gamma settings associated with each clip in the Media Pool.

Color Space Metadata in QuickTime
DaVinci Resolve is capable of reading the NCLC metadata found within media files wrapped within a QuickTime container for proper color management. This metadata consists of three values formatted as (for example) 1-1-1. From left to right, these three digits specify the Color Primary (or color space), Transfer Function (or gamma), and Color Matrix used by that media file.

These values are standardized in the SMPTE Registered Disclosure Document RDD 36:2015. For your information, the different codes are listed in the following table. In the previous example, the code of 1-1-1 indicates a standard dynamic range clip that uses the BT.709 primaries, transfer function, and color matrix.

<table>
<thead>
<tr>
<th>Color Primary</th>
<th>Transfer Function</th>
<th>Color Matrix</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Reserved</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>ITU-R BT.709</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>Unspecified</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>Reserved</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>ITU-R BT.470M</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>ITU-R BT.470BG</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>SMPTE 170M</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>SMPTE 240M</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>FILM</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>ITU-R BT.2020</td>
<td>9</td>
</tr>
<tr>
<td>10</td>
<td>SMPTE ST 428-1</td>
<td>10</td>
</tr>
<tr>
<td>11</td>
<td>DCI P3</td>
<td>11</td>
</tr>
<tr>
<td>12</td>
<td>P3 D65</td>
<td>12</td>
</tr>
<tr>
<td>–</td>
<td>–</td>
<td>13</td>
</tr>
<tr>
<td>–</td>
<td>–</td>
<td>14</td>
</tr>
<tr>
<td>–</td>
<td>–</td>
<td>15</td>
</tr>
</tbody>
</table>
The Default Input Color Space

The default Input Color Space can only be set if the “Resolve color management preset” drop-down menu is set to Custom. Otherwise, it defaults to “Rec. 709 Gamma 2.4” for all presets. Or else, this setting is the default color space that all otherwise unidentified clips in the Media Pool will default to.

Manually Tagging Clip Color Space

If necessary, you can manually identify the color space of one or more selected clips in the Media Pool by right-clicking them and choosing the Input Color Space (and optionally the Input Gamma) from the contextual menu.

Simple RCM Setup

When you first choose DaVinci YRGB Color Managed from the Color science drop-down menu of the Color Management panel in the Project Settings, you’re presented with a simple pair of menus for setting up how you want to work with Resolve Color Management: the “Resolve color management preset,” and the “Output Color Space.”

Resolve Color Management Presets

The Resolve Color Management preset menu lets you choose how you want to use RCM to grade your program. Each of these presets fully configures your project’s use of color management, and the setting you select directly impacts how you’ll grade your program. Because of this, once you choose a method of working and you grade every clip in your program, those grades rely on the preset you used being selected in order to appear as they should.

When it comes to choosing a preset, a good way to think about which to use is to choose an SDR or HDR preset that corresponds to the primary deliverable you plan on outputting. Both SDR and HDR presets have several variations that you can choose among.

While these presets correlate to how you plan on outputting your program, they don’t lock you in, since you can always change the Output Color Space (described below). This makes it possible to export multiple versions of your program, each intended for different venues, no matter which color management preset you’re using.

<table>
<thead>
<tr>
<th>Color Primary</th>
<th>Transfer Function</th>
<th>Color Matrix</th>
</tr>
</thead>
<tbody>
<tr>
<td>– –</td>
<td>16 SMPTE ST 2084 (PQ)</td>
<td>– –</td>
</tr>
<tr>
<td>– –</td>
<td>17 SMPTE ST 428-1</td>
<td>– –</td>
</tr>
<tr>
<td>– –</td>
<td>18 ARIB STD-B67 (HLG)</td>
<td>– –</td>
</tr>
</tbody>
</table>
Whenever you choose a preset, a brief description explains the workflow that preset is intended to facilitate. Here’s a list of the available presets, with slightly more detailed explanations.

- **SDR Rec.709**: (default) Sets up a Rec. 709 SDR grading environment. Your work can be converted to HDR on output, if specified, but it is limited to a Rec. 709 gamut with out-of-bounds colors being clipped. Gamma 2.4 is not mentioned in the name because scene versus display OOTF is managed automatically. Suitable for conventional streaming and broadcast.

- **SDR P3 Broadcast**: Sets up a P3-D65 SDR grading environment. Your work can be mapped to HDR for output, if specified, but it is limited to a P3-D65 gamut with out-of-bounds colors being clipped. Gamma 2.4 is not mentioned in the name because scene versus display OOTF is managed automatically. Suitable for wider gamut streaming and broadcast at SDR levels.

- **SDR P3 Cinema**: Sets up a P3-D60 SDR grading environment. Your work can be mapped to HDR for output, if specified, but it is limited to a P3-D60 gamut with out-of-bounds colors being clipped. Suitable for conventional Cinema projection.

- **SDR Rec.2020**: Sets up a Rec. 2020 SDR grading environment. Your work can be mapped to HDR for output, if specified. Good for wide gamut streaming and broadcast.

- **DaVinci Wide Gamut**: Sets up an extra wide gamut grading environment that’s suitable for grading either SDR or HDR. Capable of exporting with maximum image fidelity, preserving highlight details of up to 10,000 nits. This is a log-encoded grading space for colorists wishing to work that way. Suitable for creating mezzanine intermediates or final deliverables, or for grading HDR with high nit levels.

- **HDR P3 Broadcast**: Sets up a P3-D65 HDR grading environment. Output gamut is limited to P3-D65, with out-of-bounds colors being clipped. Suitable for grading wide gamut SDR or HDR up to 1000 nits.

- **HDR Rec.2020**: Sets up a Rec. 2020 HDR grading environment. Suitable for wide gamut SDR or HDR deliverables up to 1000 nits.

- **Custom**: If none of the available presets suits how you need to work, you can choose Custom, which exposes the full set of RCM settings for you to set up to suit your needs.

**IMPORTANT**

For all presets, importing media that’s in an identical or smaller gamut maps the image data into the larger color space of the preset without transforming it. Importing media with a wider gamut than the color space of the preset remaps the image data to fit into the smaller color space, while preserving as much image detail as possible.

**Output Color Space**

For most DaVinci Resolve installations and projects, you’ll set your Output Color Space to match the needs of your program, according to your display’s capabilities (or the capabilities your display is set to use for the project at hand). You’ll also typically use a Resolve Color Management preset that matches those capabilities.

However, RCM gives you the flexibility of grading in one color space and then outputting to others, when necessary. For example, it’s easy to grade an SDR Rec. 709 version of a program for streaming or broadcast, and then switch the Output Color Space to SDR P3 Cinema to output an additional deliverable for theatrical exhibition.
To facilitate this, you can set the Output Color Space to any setting, independent of the Resolve Color Management preset you’ve selected, and DaVinci Resolve will automatically convert from your Color Management Preset to the Output Color Space of your choice. When you do so, here are the rules that govern the resulting image transform.

When going SDR to HDR:

- 0-50 nits (18% mid-gray) in your program is mapped to 0-50 nits on output (no change).
- Everything from 51-90 nits in your program is remapped from 51 to 100 nits (slightly expanded).
- Everything from 91-100 nits in your program is remapped from 101 to 1000 nits (greatly expanded).

When going from HDR to SDR, the reverse is done:

- 0-50 nits (18% mid-gray) in your program is mapped to 0-50 nits on output (no change).
- Everything from 51 to 100 nits in your program is remapped from 51-90 nits (slightly compressed).
- Everything from 101 to 1000 nits in your program is remapped from 91-100 nits (greatly compressed).

While these methods of converting between SDR and HDR provide an effective starting point for conversion, they’re not meant to be an automatic solution. It’s critical that you do a trim pass whenever outputting a deliverable in a new color space and EOTF, so you can check every clip and make adjustments to improve the result when necessary.

**NOTE:** When converting SDR to HDR, this behavior may exaggerate noise in imported SDR media that happens to have large flat expanses of bright colors. If you see particular clips that show this issue, you can disable this behavior on a clip by clip basis in the Media Pool clip contextual menu, or the Thumbnail Timeline contextual menu in the Color page, by toggling “Inverse DRT for SDR to HDR Conversion.”

**Advanced RCM Setup**

Advanced users who need more detailed control over every aspect of RCM can choose Custom from the Resolve Color Management preset menu. This exposes every control that’s available, which opens a world of workflow possibilities for advanced users and post production facilities.

Because each of the settings encompasses a significant amount of functionality, the following sections cover each particular parameter in detail.
Custom Color Management settings of Resolve Color Management, as updated in DaVinci Resolve 17

**NOTE:** Older projects using RCM will have Color science set to Legacy, to preserve the older color management settings and color transformations effect on your work. For more information on how the previous generation of RCM works, see the September 2020 version of the DaVinci Resolve 16 Manual.

**Single Setting vs. Dual Setting RCM**

There are two ways you can set up RCM. When the “Use Separate Color Space and Gamma” checkbox is turned off, the Color Management panel of the Project Settings exposes one drop-down each for the Input, Timeline, and Output Color Space settings. Each setting lets you simultaneously transform the gamut and gamma, depending on which option you choose. This makes it a bit simpler to set up the transform you need.

If you turn the “Use Separate Color Space and Gamma” checkbox on, then the Color Management panel changes so that the Input, Timeline, and Output Color Space settings each display two pop-ups. The first drop-down lets you explicitly set the gamut, while the second drop-down lets you explicitly set the gamma. This makes it easier to see exactly which pair of transforms is being used at each stage of RCM.
Additionally, Dual Setting RCM enables you to assign separate gamut and gamma transforms to clips in the Media Pool.

Dual setting Resolve Color Management assignments for Media Pool clips

Setting the Input Color Space

This setting is the default color space that all otherwise unidentified clips in the Media Pool will default to, unless you manually identify the color space of these clips by right-clicking them and choosing an Input Color Space (and optionally Input Gamma) from the contextual menu.

This setting does not affect media in camera raw formats, or media with embedded color space metadata.

Choosing a Timeline Color Space

The Timeline Color Space is the "working" color space that determines how each clip's contrast and color are mapped for adjustment, which in turn has an impact on how sensitive the effects and grading controls are as you work. Some colorists prefer to work in the classic "video" color space of Rec. 709, since the controls feel comfortable and familiar, particularly if you're mastering SDR content. On the other hand, colorists who are used to working with log-encoded media (likely using the Log controls) often prefer to work in a more film-oriented workflow using Cineon, LogC, or other wide gamut, logarithmically encoded formats.

If you're outputting an SDR deliverable, any color space that you're comfortable will produce good results. However, if you're outputting an HDR deliverable, it's in your best interest to choose a wide gamut Color Space (and Gamma) to obtain the best results on output. In this instance, DaVinci Wide Gamut is a great choice (see below for more information).

No matter which Timeline Color Space you choose to work in, all clips in an edit are transformed from the Input Color Space that's either automatically or manually assigned to them, to the Timeline Color Space setting to provide the final output. This is how you can grade within a Log-encoded timeline color space and yet view a normalized or de-logged image.

IMPORTANT

Once you choose a Timeline Color Space and begin grading, do not change your Timeline Color Space, or you'll end up changing all of the grades that are built using the mathematics it defines. You can always change the Output Color Space to create a new deliverable, but all of your grades depend on the Timeline Color Space to render correctly.

DaVinci Wide Gamut Color Space and DaVinci Intermediate Gamma

DaVinci Wide Gamut (DaVinci WG) and DaVinci Intermediate are Timeline Color Space and Gamma settings developed by Blackmagic Design that provide a reliable universal internal working color space, which encompasses a practical maximum of what image data any given camera can capture. The DaVinci Wide Gamut color space is greater than BT.2020, ARRI Wide Gamut, and even ACES, so you don't ever lose image data, no matter where your media is coming from.

Furthermore, the primary color values of the DaVinci WG color space are set such that the process of automatically mapping source media from different cameras into this gamut is extremely accurate as part of the Input to Timeline Color Space conversion, and tone and saturation mapping from one color space to another can be done more accurately in the Timeline to Output Color Space conversion.
This also helps to produce greater consistency among media from different cameras when making manual grading adjustments (though some variations due to differences in camera and lens systems will remain).

The DaVinci Wide Gamut color space

The DaVinci Intermediate OETF gamma setting has been designed to work with DaVinci Wide Gamut to provide a suitable internal luminance mapping of high precision image data, in preparation for mastering to either HDR or SDR standards, as your needs require, without losing image data.
Resolve Color Management is extremely flexible, so you don’t have to use DaVinci Wide Gamut/ DaVinci Intermediate as your Timeline color space if you don’t want. However, it presents many advantages and is worth trying out to see if it can improve your workflow.

For more information, see the “DaVinci Resolve Wide Gamut Intermediate” document at https://www.blackmagicdesign.com/support/family/davinci-resolve-and-fusion.

Timeline Working Luminance

This control is only visible while the Resolve Color Management presets menu is set to Custom Settings. The Timeline Working Luminance drop-down menu lets you choose how the Input DRT (described below) maps the maximum level of a source image to the currently selected Timeline Color Space. This setting also defines the maximum highlight level that’s possible to output into the currently selected Output Color Space using the Output DRT.

While it’s typical to set this according to the mastering standard you’re grading to via a collection of SDR and HDR labeled settings, there are additional settings available that make it possible to add more automatic compression of highlights as you grade.

- **SDR 100**: The conventional setting for grading SDR material with a maximum level of 100 nits.
- **HDR 500-4000**: Conventional settings for grading HDR material at a variety of maximum mastering levels. So long as output DRT isn’t set to None, there will be some manner of rolloff in the highlights, unless inverse DRT is enabled, in which case there will be no rolloff.
- **SDR and HDR ER settings**: These “extended range” settings each specify two values and provide more headroom for aggressive grading of highlights by enabling DaVinci Resolve to compress a greater range of out-of-bounds image data without clipping, which can result in a smoother look.

Here’s how it works. Suppose you choose the setting “HDR ER 1000/2000.” In this case, the Input DRT is used to map the maximum brightness of each source image to the range specified by the first value, which is 1000 nits. Then, when you grade, the signal isn’t clipped until it reaches the maximum range specified by the second value, which is 2000 nits. This provides an additional 1000 nits of out-of-bounds headroom before the image data is hard clipped by RCM’s image processing pipeline. The Output DRT is then used to map from the maximum brightness specified.
by the second number (2000 nits) to the output value defined by the currently selected Output Color Space, in the process compressing this out-of-bounds headroom to preserve as much highlight detail as is possible given the range you’ve selected.

- **Custom**: Exposes a field where you can enter a specific nit value.

### 203 Nit Support for SDR to HDR

This control is only visible while the Resolve Color Management presets menu is set to Custom Settings. Resolve Color Management has support for remapping SDR content to HDR by mapping 100 nits to 203 nits (defined as the diffuse white level) according to the BT.2100 recommendation. This enables the peak highlights of SDR material to compete more favorably against the significantly brighter highlights of HDR content in programs that combine both (such as documentaries), so that SDR whites continue to appear white, rather than gray, when compared to diffuse white in HDR.

The checkbox that enables this is hidden by default. Whenever you set the Output to an HDR standard while the Timeline is set to an SDR standard, the “Use 203 nits reference for Rec.2100 HDR” checkbox for remapping SDR highlights to HDR appears in both the RCM settings of the Color Management panel of the Project Settings and in the Color Space Transform Resolve FX plug-in.

[Image of checkbox for 203 Nit Support]

The “Use 203 nits reference for Rec.2100 HDR” checkbox in Resolve Color Management for scaling SDR levels appropriately into HDR color space

### Gamut Limiting, Restricting Values Within a Larger Gamut

This control is only visible while the Resolve Color Management presets menu is set to Custom Settings. In the emerging world of larger gamuts for distribution, it’s increasingly common for delivery specifications to specify output to a large gamut, such as Rec. 2020, yet require that image values be restricted to a smaller gamut, such as P3. This is to allow delivery to “future-proofed” delivery standards, while preventing saturation values that are too high to be displayed on consumer displays that aren’t capable of implementing the full scope of those standards.

In this case, you’ll choose a larger gamut in Output Color Space, but you’ll then choose a smaller gamut in “Limit Output Gamut To.” When you do this, all image values falling outside the “Limit Output Gamut To” standard specified will be hard clipped. This setting defaults to None.

[Image of gamut limiting settings]

Choose a setting from the Limit Output Gamut To menu to limit image values within a larger gamut.
Input DRT Tone Mapping

This control is only visible while the Resolve Color Management presets menu is set to Custom Settings. RCM has always transformed the color primaries of different media formats to match one another within the shared Timeline Color Space. In this updated version, the Input DRT (Display Rendering Transform) drop-down menu provides a variety of different options to enable DaVinci Resolve to automatically tone map the image data of SDR and HDR clips to better match one another when they’re fit into the currently selected Timeline Color Space. While each option varies in the details, they are all automated input-to-timeline color transforms that do the following:

- **Log-encoded media, or media using a 2.4 gamma transfer function, is mapped so the black point, midtones at 18% gray, and white levels match those of HDR media. Highlight data will be carefully stretched as necessary so that the highlights of all clips in the Timeline, whether SDR or HDR, are treated similarly.**
- **Raw formats such as BRAW, RED, and ARRI RAW, and media using HDR transfer functions are minimally mapped along an HDR range of tonality.**
- **All color transforms into the Timeline Color Space are done without clipping.**

The idea is to distribute the image data of each clip in the Timeline, be it SDR or HDR media, along a similar histogram, with shadows, midtones, and highlights spread out in such a way as to create an easier starting point for grading. One result of this is that grades made for one type of media mostly work well with other types of media.

Different options are provided governing the details of how this Input to Timeline Color Space transform is achieved. They all do the same thing but have different advantages.

- **None:** This setting disables Input DRT Tone Mapping. No tone mapping is applied to the Input to Timeline Color Space conversion at all, resulting in a simple 1:1 mapping to the Timeline Color Space.
- **Simple:** A good mapping for color transforms from HDR to SDR.
- **Luminance Mapping:** Same as DaVinci, but more accurate when the Input Color Space of all your media is in a single standards-based color space, such as Rec. 709 or Rec. 2020.
- **DaVinci:** This option tone maps the transform with a smooth luminance roll-off in the shadows and highlights, and controlled desaturation of image values in the very brightest and darkest parts of the image. This setting is particularly useful for wide-gamut camera media and is a good setting to use when mixing media from different cameras.
- **Saturation Preserving:** This option has a smooth luminance roll-off in the shadows and highlights, but does so without desaturating dark shadows and bright highlights, so this is an effective option for colorists who like to push color harder. However, because over-saturation in the highlights of the image can look unnatural, two parameters are exposed to provide some user-adjustable automated desaturation.
  - **Sat. Rolloff Start:** Lets you set a threshold, in nits (cd/m²), at which saturation will roll off along with highlight luminance. Beginning of the rolloff.
  - **Sat. Rolloff Limit:** Lets you set a threshold, in nits (cd/m²), at which the image will be totally desaturated. End of the rolloff.

Output DRT Tone Mapping

This control is only visible while the Resolve Color Management presets menu is set to Custom Settings. To accommodate workflows where you need to transform one color space into another that has a dramatically larger or smaller gamut, an additional group of settings have been added that can help to automate the expansion or contraction of image data necessary to give a pleasing result.
Using the available options in the Output DRT drop-down menu will compress or expand your image data as necessary during the Timeline to Output Color Space transformation that RCM performs when monitoring or rendering a timeline, in order to make sure that the final result is either not clipping, or to ensure that it’s taking better advantage of the new color space. This is not meant to provide your final grade. Rather, it’s meant to give you a faster starting point, when you need it, for proceeding with your own more detailed grade of the result.

Here are some examples of what the Gamut Mapping controls of RCM can be used for:

1. If you’re working with high-dynamic-range log-encoded media and you’re outputting to Rec. 709 as you work, turning on Gamut Mapping lets RCM use saturation and tone mapping to give you a more immediately pleasing image with highlight detail that’s not clipped.

2. If you’re working with standard-dynamic-range log-encoded media and you’re outputting to an HDR format as you work, turning on Gamut Mapping lets RCM use saturation and tone mapping to expand the highlights of the image to HDR strength to give you an image with more immediate visual impact on HDR screens.

The Output DRT (Display Rendering Transform) drop-down menu provides the following options.

- **None**: No tone mapping is applied to the Timeline to Output Color Space conversion at all, resulting in a simple 1:1 output with no softness or rolloff applied. All image data outside of gamut will be clipped.

- **Simple**: A good mapping for color transforms from HDR to SDR.

- **Luminance Mapping**: Same as DaVinci, but more accurate when all your media is in a single standards-based color space, such as Rec. 709 or Rec. 2020, set to the Timeline and Output.

- **DaVinci**: This option tone maps your output with a smooth luminance roll-off in the shadows and highlights, and controlled desaturation of image values in the very brightest and darkest parts of the image. It’s been designed to give smooth, naturalistic highlights and shadows as you push and pull the values of your images, without the need for additional settings. This setting is particularly useful for wide-gamut camera media and is a good setting to use when mixing media from different cameras.
– **Saturation Preserving**: This option has a smooth luminance roll-off in the shadows and highlights to prevent clipping. It does so without desaturating dark shadows and bright highlights, so this is an effective option for colorists who like to push color a bit harder. However, because over saturation in the highlights of the image can look unnatural, two parameters are exposed to provide some user-adjustable automated desaturation.

– **Sat. Rolloff Start**: Lets you set a threshold, in nits (cd/m²), at which saturation will roll off along with highlight luminance. Beginning of the rolloff.

– **Sat. Rolloff Limit**: Lets you set a threshold, in nits (cd/m²), at which the image will be totally desaturated. End of the rolloff.

– **RED IPP2**: This setting lets you use RED IPP2 tone mapping to output to an SDR format, such as Rec. 709; two settings are exposed with which to choose how your output will be shaped.

– **Output Tone Map**: Lets you choose what kind of tone mapping you want to use for your output. Options include: None, Low, Medium, and High.

– **Highlight Roll Off**: Lets you choose what kind of highlight rolloff you want to use to prevent clipping. Options include: None, Hard, Medium, Soft, and Very Soft.

– **HDR peak nits**: A slider lets you choose the peak nit level you want to tone map to. Defaults to 10,000 nits.

**Use Inverse DRT for SDR to HDR Conversion**

This control is only visible while the Resolve Color Management presets menu is set to Custom Settings. A device rendering transform (DRT) is typically used when converting high dynamic range media to a lower dynamic range color space/mastering standard. Thus, setting up a color transform from SDR to HDR is an “inverse” operation to expand the dynamic range of SDR media to HDR standards. The way this works is that levels at 100 nits are mapped to the maximum value set for the Timeline Working Luminance parameter, and all other image levels are strategically tone mapped in order to give yourself a good starting point for grading SDR media into an HDR program.

This setting also has a secondary use. With this setting turned on, you can output Rec. 709 clips with color that’s identical to the input, with no compression in the highlights.

**NOTE:** Turning on “Use Inverse DRT for SDR to HDR Conversion” may exaggerate noise in imported SDR media with large flat expanses of bright colors.

**Use White Point Adaptation**

This control applies a chromatic adaptation transform to account for different white points between color spaces.

– Uncheck this box if you simply want to view the input color space’s white point unaltered in the output color space. For example, wanting to use a P3-D60 mastered clip inside a P3-D65 timeline for reference purposes.

– Check this box to apply the chromatic adaptation transform to convert the input white point to match the output color space’s white point. For example, wanting a P3-D60 mastered clip to cut in with other clips mastered in a P3-D65 timeline.

**NOTE:** This control is only visible while the Resolve Color Management presets menu is set to Custom Settings.
**Color Space Aware Grading Tools**

In DaVinci Resolve version 17, both Resolve Color Management and ACES enables “color space aware” palettes, such as the new HDR palette, to have controls that feel consistent, no matter what color space the original media is from, or what Timeline Color Space you’re using.

Other palettes, such as the Qualifier and Curves palettes, become color space aware when you turn on the “Use Color Space Aware Grading Tools” checkbox in the Color Management panel of the Project Settings (this is turned on by default). When you’re using color space aware grading tools, you should not turn on HDR Mode for the node you’re working on.

- In the case of the Qualifier palette, this enables Qualifiers to create high-quality keys as you would expect, no matter what the color space of the original media is, or what Timeline Color Space you’re using.
- In the case of the Curves palette, this makes the overall range of each curve better fit the overall data range of the current clip, making curves adjustments easier and more specific.

**NOTE:** This control is only visible while the Resolve Color Management presets menu is set to Custom Settings.

**Apply Resize Transformations In**

When you’re using Resolve Color Management, a new “Apply Resize Transformations In” Project Setting is available in the Color Management panel while the Resolve Color Management presets menu is set to Custom Settings. This setting lets you choose which color space is used for resizing operations. Ordinarily, resizing is done in Linear, but certain specialty workflows benefit from doing resizing in other color spaces, so this option lets you choose which is best. The available options are:

- **Timeline:** Uses the Timeline Color Space to perform all resizing operations.
- **Log:** Uses a Log Color Space for resizing. Good for avoiding artifacts in certain high-contrast images, such as titles and star fields.
- **Linear:** Usually provides the best results with most SDR media.
- **Linear Mapped:** Usually provides the best results with most HDR media.
- **Gamma:** Provided in case you find a need for this option.
- **Gamma Mapped:** Usually provides best results when mixing SDR media with wide gamut and log-encoded media on the same timeline.

**Graphics White Level**

The “Graphics white level” setting lets you define a shared maximum level in nits (cd/m²) for titles, generators, and selected effects that generate color. Changing this setting lets you change the maximum level of all DaVinci Resolve-generated titles, generator graphics, and effects at once to accommodate different mastering and output requirements.

**Display HDR On Viewers If Available**

Turn this checkbox on if your computer monitors and operating system are capable of accommodating HDR display. This allows the Viewers to show true HDR, according to the capabilities of your computer monitor.
**HDR Mastering Is For**

(Only available in Studio version)

If you have a DeckLink 4K Extreme 12G or an UltraStudio 4K Extreme video interface, then DaVinci Resolve 12.5 and above can output the metadata necessary to correctly display HDR video signals to display devices using HDMI 2.0a when you turn on the “Enable HDR metadata over HDMI” checkbox in the Master Project Settings.

![Enable HDR metadata over HDMI](image)

The Enable HDR metadata over HDMI option in the Master Project Settings lets you output HDR via HDMI 2.0a.

When you do so, a setting in the Color Management panel of the Project Settings, “HDR mastering is for X” lets you specify the output, in nits, to be inserted as metadata into the HDMI stream being output, so that the display you’re connecting to correctly interprets it. The output you specify should match what your display is expecting.

![HDR mastering is for](image)

The “HDR mastering is for” setting lets you insert metadata for HDR output via HDMI 2.0a.

**Resolve Color Management and the Fusion Page**

Enabling RCM also allows the Fusion page to handle the color of clips automatically. Images output by MediaIn nodes are automatically converted to Linear color space, which is the preferred color space with which to perform high-quality compositing operations. Setting the LUT menu of each Viewer in the Fusion page to Managed ensures that you’re looking at the image in Rec. 709, so that the image looks correct to the artist even though they’re really working in the Linear color space. Each MediaOut node then converts the image back to the timeline color space for handoff to the Color page.

With RCM off, you must manage color in the Fusion page manually, either using the Source Color Space and Source Gamma Space settings of each MediaIn node, or using the CineonLog or FileLUT nodes in your node tree.

For more information on how color management affects the Fusion page, and why the Linear color space is preferable for compositing, see Chapter 77, “Controlling Image Processing and Resolution.”

**Ability to Bypass Color Management Per Clip**

When you right-click a clip in the Thumbnail Timeline of the Color page, a “Bypass Color Management” setting appears underneath the Input Color Space and Input Gamma submenus that let you identify a clip’s color characteristics. Choosing this option so that it appears checked lets you exclude that clip from color management altogether, in the event you want to manually manage that clip using LUTs, the Color Space Transform node, or simply by doing manual grading.
Exporting Color Space Information to QuickTime Files

If you render QuickTime files from the Deliver page, then color space tags will be embedded into each file based on either the Timeline Color Space (if Resolve Color Management is disabled) or the Output Color Space (if Resolve Color Management is enabled). Two settings in the Advanced Settings of the Render Settings let you choose how color space metadata will be embedded into your output for supported media formats, “Color Space Tag,” and “Gamma Tag.” These default to “Same as Project,” which will match the Output Color Space currently selected in the Project Settings.

Color Management Using ACES

The ACES (Academy Color Encoding Specification) color space has been designed to make scene-referred color management a reality for high-end digital cinema workflows. ACES also makes it easier to extract high-precision, wide-latitude image data from raw camera formats, in order to preserve high-quality image data from acquisition through the color grading process, and to output high-quality data for broadcast viewing, film printing, or digital cinema encoding.

An oversimplification of the way ACES works is that every camera and acquisition device is characterized to create an IDT (Input Device Transform) that specifies how media from that device is converted into the ACES color space. The ACES gamut has been designed to be large enough to encompass all visible light, with more than 25 stops of exposure latitude. In this way ACES has been designed to be future-proof, taking into consideration advances in image capture and distribution.

Meanwhile, an RRT (Reference Rendering Transform) is used to transform the data provided by each image format’s IDT into standardized, high-precision, wide-latitude image data that in turn is processed via an ODT (Output Device Transform). Different ODT settings correspond to each standard of...
monitoring and output, and describe how to accurately convert the data within the ACES color space into the gamut of that display in order to most accurately represent the image in every situation. The RRT and ODT always work together.

![ACES signal and processing flow](image)

By using the ACES color space and specifying an IDT and an ODT, you can ingest media from any capture device, grade it using a calibrated display, output it to any destination, and preserve the color fidelity of the graded image.

### Setting Up ACES in the Project Settings Window

There are four parameters available in the Color Science drop-down of the Color Management panel of the Project Settings that let you set up DaVinci Resolve to use the ACES workflow:

- **Color science is:** Using this drop-down menu, you can choose either DaVinci ACES, or DaVinci ACEScc color science, which enables ACES processing throughout DaVinci Resolve.

  - **ACEScc:** Choose DaVinci ACEScc color science to apply a standard Cineon-style log encoding to the ACES data before it is processed by DaVinci Resolve. This well defined common encoding makes it possible for ASC CDL values to be used across systems using the same ACEScc encoding. After processing, a reverse encoding is applied in order to output ACES linear data.

  - **ACEScct:** A variation of ACEScc that adds a roll-off at the toe of the image that’s different from the encoding of ACEScc, in order to make color correction lift operations “feel” more like they do with film scans and LogC encoded images, which makes it easier to raise the darkest values of the image and get milky shadows, something that can be difficult with ACEScc. After processing, a reverse encoding is applied in order to output ACES linear data.

- **ACES Version:** When you’ve chosen one of the ACES color science options, this drop-down becomes available to let you choose which version of ACES you want to use. As of DaVinci Resolve 15, you can choose from ACES 1.0.3 or ACES 1.1 (the latest version).

- **ACES Input Device Transform:** This drop-down menu lets you choose which IDT (Input Device Transform) to use for the dominant media format in use. DaVinci Resolve currently supports the following IDTs:

  - **ACEScc/ACEScct/ACEScg:** Standardized transforms for each of these ACES standards.

  - **ADX (10 or 16):** 10-bit or 16-bit integer film-density encoding transforms meant for use if you’re working with film scans that were initially encoded in an ACES workflow. This transform is designed to maintain the variation in look between different film stocks.
- **ALEXA**: Color management settings for all ARRI ALEXA cameras.
- **BMD Film/4K/4.6K**: Color management settings for Blackmagic Design cameras.
- **Canon 1D/5D/7D/C200/C300/C300MkII/C500/C700**: Color management settings for Canon cameras.
- **DCDM**: This IDT transforms X’Y’Z’-encoded media with a gamma of 2.6.
- **DCDM (P3D65 Limited)**: This IDT transforms X’Y’Z’-encoded media with a gamma of 2.6, specifically hard clipped to a P3 gamut with a D65 white point.
- **DRAGONcolor/2 and REDgamma3/4/REDlogFilm combinations**: Different combinations of the DRAGONcolor, REDgamma, and REDlogFilm settings are provided for legacy RED workflows.
- **P3-D60**: Transforms RGB-encoded image data with a D60 white point, intended for monitoring with a P3-compatible display using a D60 white point.
- **P3-D65**: Transforms RGB-encoded image data with a D65 white point; intended for monitoring with a P3-compatible display using a D65 white point.
- **P3-D65 (D60 sim.)**: Transforms RGB-encoded image data with a D65 white point; intended to simulate monitoring with a P3-compatible display using a D60 white point on a display with D65.
- **P3-D65 ST2084 (108/1000/2000/4000 nits)**: Transforms an image that’s compatible with the P3 color gamut, using the SMPTE standard PQ (ST.2084) tone curve for High Dynamic Range (HDR) post-production. Three settings for four different peak luminance ranges are provided; which one is appropriate to use depends on the maximum white level of the display used to create the media. Preliminary standards exist for HDR displays with peak luminance at 1000 nits, 2000 nits, and 4000 nits. A setting of 108 nits is provided for Kodak laser projection.
- **P3-D65**: Transforms RGB-encoded image data with a D65 white point, intended for monitoring with a P3-compatible display using a D65 white point.
- **P3-D65 ST2084 (1000/2000/4000 nits)**: Transforms an image that’s compatible with the P3 color gamut, using the SMPTE standard PQ (ST.2084) tone curve for High Dynamic Range (HDR) post-production. Three settings provided for three different peak luminance ranges; which one is appropriate to use depends on the maximum white level of the display used to create the media. Preliminary standards exist for HDR displays with peak luminance at 1000 nits, 2000 nits, and 4000 nits.
- **P3-DCI (D60 sim.)**: Produces output that’s specifically for output on a DCI projector with a D60 white point. This output may look magenta on other display devices that aren’t set up for DCI display.
- **P3-DCI (D65 sim.)**: Produces output that’s specifically for output on a DCI projector with a D65 white point. This output may look magenta on other display devices that aren’t set up for DCI display.
- **Panasonic V35**: Color management settings for each listed camera.
- **Rec.2020**: This IDT transforms media created with the wide-gamut standard for consumer and broadcast television.
- **Rec.2020 ST2084 (1000/2000/4000 nits)**: This IDT transforms media created within the wide-gamut standard for consumer and broadcast television, using the SMPTE standard PQ (ST.2084) tone curve for High Dynamic Range (HDR) post-production. Three settings provided for HDR televisions with different peak luminance capabilities.
- **Rec.2020 HLG (1000 nits)**: This IDT transforms media within the wide-gamut standard for consumer and broadcast television and uses the Hybrid Log-Gamma (HLG) standard tone curve for High Dynamic Range (HDR) post-production. A single setting is provided for HDR televisions with peak luminance at 1000 nits.
– **Rec.709 (Camera):** A deprecated legacy IDT for Rec. 709 that’s included for backward compatibility. Converts the source data to linear based on Rec. 709 and transforms the result to ACES, but while this transformation is technically correct, it’s not necessarily pleasing after conversion through the matching ODT. For this reason, the academy updated to the following Rec. 709 IDT, which is the inverse of the Rec. 709 ODT.

– **Rec.709:** A standard transform designed to move media in the Rec. 709 color space into the ACES color space. This option is used for any other file type that might be imported, such as ProRes from Final Cut Pro, DNxHD from Media Composer, and any media file captured from tape.

– **Rec.709 (D60 sim.):** A standard transform designed to move media in the Rec. 709 color space with a white point of D60 into the ACES color space.

– **REDColor2/3/4/REDGamma3/4/REDLogFilm combinations:** Different combinations of the REDcolor, REDgamma, and REDlogFilm settings are provided for legacy RED workflows.

– **RWGLog3G10:** The standardized RED IPP2 color pipeline transform for all RED camera media.

If you’re working on a project that mixes media formats that require different IDTs, then you can assign different IDTs to clips using the Media Pool’s contextual menu, or using the Clip Attributes window, which is also accessible via the Media Pool’s contextual menu.

– **ACES Output Device Transform:** This drop-down menu lets you choose an ODT (Output Device Transform) with which to transform the image data for monitoring on your calibrated display, and when exporting a timeline in the Deliver page. You can choose from the following options:

  – **ADX (10 and 16):** A standardized ODT designed for media destined for film output. Two settings accommodate 10-bit and 16-bit output. This ODT is not meant to be used for monitoring.

  – **DCDM:** This ODT exports X’Y’Z’-encoded media with a gamma of 2.6 intended for handoff to applications that will be re-encoding this data to create a DCP (Digital Cinema Package) for digital cinema distribution. This can be displayed via an XYZ-capable projector.

  – **DCDM (P3D60 Limited):** Outputs a P3 hard-limited signal with a D60 white point.

  – **DCDM (P3D65 Limited):** Outputs a P3 hard-limited signal with a D65 white point.

  – **P3 D60:** Outputs RGB-encoded image data with a D60 white point; intended for monitoring with a P3-compatible display using a D60 white point.

  – **P3 D65:** Outputs RGB-encoded image data with a D66 white point; intended for monitoring with a P3-compatible display using a D66 white point.

  – **P3 D65 (D60 sim.):** Outputs RGB-encoded image data to simulate monitoring with a P3-compatible display using a D60 white point on a display with a D65 white point.

  – **P3 D65 (Rec.709 Limited):** Outputs RGB-encoded image data with a D65 white point within a P3 gamut that’s hard-limited to the color range of Rec. 709.

  – **P3 D65 ST2084 (108/1000/2000/4000 nits):** Outputs an image that’s compatible with the P3 color gamut, using the SMPTE standard PQ tone curve for High Dynamic Range (HDR) post-production. Three settings for three different peak luminance ranges are provided; which one is appropriate to use depends on the maximum white level of your display. Preliminary standards exist for HDR displays with peak luminance at 1000 nits, 2000 nits, and 4000 nits. A setting of 108 nits is provided to simulate an HDR signal clipped to an SDR range.

  – **P3 DCI (D60 sim.):** Outputs RGB-encoded P3 image data that appears as if with a D60 white point on a DCI projector with a DCI white point.

  – **P3 DCI (D65 sim.):** Transforms RGB-encoded image data with a D61 white point (the DCI mastering standard) that appears as if with a D65 white point.
– **P3-D65 ST2084 (1000/2000/4000 nits):** Transforms an image that’s compatible with the P3 color gamut, using the SMPTE standard PQ (ST.2084) tone curve for High Dynamic Range (HDR) post-production. Three settings for three different peak luminance ranges are provided; which one is appropriate to use depends on the maximum white level of the display used to create the media. Preliminary standards exist for HDR displays with peak luminance at 1000 nits, 2000 nits, and 4000 nits.

– **Rec.2020:** This ODT is for compatibility with the full range of this wide-gamut standard for consumer and broadcast television.

– **Rec.2020 (P3D65 Limited):** Outputs a P3D65 hard-limited signal within this wide-gamut standard for consumer and broadcast television.

– **Rec.2020 (Rec.709 Limited):** Outputs a Rec. 709 hard-limited signal within this wide-gamut standard for consumer and broadcast television.

– **Rec.2020 HLG:** Outputs the full Rec. 2020 gamut to the Hybrid Log-Gamma standard for HDR.

– **Rec.2020 HLG (1000 nits, P3D65 Limited):** Outputs a 1000 nit, P3D65 hard-limited signal within the Rec. 2020 gamut and the Hybrid Log-Gamma standard for HDR.

– **Rec.2020 ST2084 (1000/2000/4000 nits):** This ODT transforms media created within the wide-gamut standard for consumer and broadcast television, using the SMPTE standard PQ (ST.2084) tone curve for High Dynamic Range (HDR) post-production. Three settings are provided for HDR televisions with different peak luminance capabilities.

– **Rec.2020 ST2084 (1000/2000/4000 nits, P3D65 Limited):** This ODT transforms media within the wide-gamut standard for consumer and broadcast television but with hard clipping at the boundary of the P3 gamut for televisions that are limited to the smaller P3 gamut for digital cinema; also uses the SMPTE standard PQ (ST.2084) tone curve for High Dynamic Range (HDR) post-production. Three settings are provided for HDR televisions with different peak luminance capabilities.

– **Rec.709:** This ODT is used for standard monitoring and deliverables for TV.

– **Rec.709 (D60 Sim):** A standard transform designed to move media in the Rec. 709 color space with a white point of D60 into the ACES color space.

– **sRGB:** A standardized transform designed for media created for computer display in a consumer environment.

– **sRGB (D60 Sim):** A standardized ODT designed for media destined for computer display in a consumer environment. Suitable for monitoring when grading programs destined for the web.

– **ACEScc/ACEScct/ACEScg:** Standardized transforms for each of these ACES standards.

You must manually select an ODT that matches your workflow and room setup when working in ACES.

– **Process Node LUTs in:** This drop-down menu lets you choose how you want to process CLF LUTs that are added to nodes in your grades while working in ACES, such as Look LUTs in on-set or VFX workflows. There are two choices: ACEScc AP1 Timeline Space (the default), and ACES AP0 Linear.

– **ACEScc AP1:** For LUTs that have been designed to take the specific range of ACEScc data using the AP1 primary coordinates.

– **ACES AP0:** For LUTs that have been designed for normal ACES data from 65504 to -65504 floating point values.
NOTE: ACES grades require CLF LUTs that have been specifically created for ACES workflows. If you want to apply a regular LUT within a grade, you must do a color space transform to convert the image from ACES to whatever space the LUT was designed to work within, and then another color space transform to convert the image back to ACES; however, this workflow does not always provide ideal results.

The Initial State of Clips When Working in ACES
Don’t worry if the initial state of each image file appears differently than what was monitored originally on set. What’s important is that if the camera original media was well exposed, the IDT used in ACES mode will retain the maximum amount of image data, and provide the maximum available latitude for grading, regardless of how the image initially appears on the Timeline.

The Timeline Color Space in ACES Workflows is Fixed
When you’re working in ACES, you do not get to change the Timeline Color Space as you do in Resolve Color Management. The ACES working color space is a log-encoded color space, which encourages a more traditional, film-oriented approach to grading.

Tips for Rendering Out of an ACES Project
When choosing an output format in the Deliver page, keep the following in mind:

– If you’ve delivering graded media for broadcast, set the ACES Output Device Transform to be Rec. 709, then you can output to whatever media format is convenient for your workflow.

– When you’re delivering graded media files to another ACES-capable facility using the DCDM or ADX ODCs, you should choose the OpenEXR RGB Half (uncompressed) format in the Render Settings, and set the ACES Output Device Transform to “No Output Device Transform.”

– When you’re rendering media for long-term archival, you should choose the OpenEXR RGB Half (uncompressed) format in the Render Settings, and set the ACES Output Device Transform to “No Output Device Transform.”
Chapter 9
HDR Setup and Grading

High Dynamic Range (HDR) grading for cinema, television, and streaming is the latest evolution of the consumer media experience. While HDR workflows in high-end cinema and television aren’t new, this way of mastering media has been slow to expand to less expensive programming. However, new developments and an expanding array of affordable HDR-capable consumer devices are poised to make HDR mastering of visual content increasingly ubiquitous. This chapter describes what HDR is for the uninitiated and covers the operational details that will let you set up DaVinci Resolve to do HDR grading.

Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Dynamic Range (HDR) Grading in DaVinci Resolve</td>
<td>210</td>
</tr>
<tr>
<td>HDR Isn’t Just for Televisions</td>
<td>211</td>
</tr>
<tr>
<td>The Different Ways of Mastering HDR</td>
<td>211</td>
</tr>
<tr>
<td>What Do I Do With HDR?</td>
<td>212</td>
</tr>
<tr>
<td>Analyzing HDR Signals Using Video Scopes</td>
<td>212</td>
</tr>
<tr>
<td>Dolby Vision®</td>
<td>213</td>
</tr>
<tr>
<td>Organizing Your Timeline for Dolby Vision Mastering</td>
<td>215</td>
</tr>
<tr>
<td>Letterboxing for Dolby Vision Mastering</td>
<td>215</td>
</tr>
<tr>
<td>Setting Up Color Management for Dolby Vision Mastering</td>
<td>216</td>
</tr>
<tr>
<td>Choosing Mastering Displays for Dolby Vision</td>
<td>216</td>
</tr>
<tr>
<td>Using the Dolby Vision Internal Content Mapping Unit (iCMU)</td>
<td>216</td>
</tr>
<tr>
<td>Simultaneous Master and Target Display Output for Dolby Vision</td>
<td>217</td>
</tr>
<tr>
<td>External Content Mapping Unit (eCMU) for Dolby Vision</td>
<td>217</td>
</tr>
</tbody>
</table>

Dolby, Dolby Vision, and the double-D symbol are registered trademarks of Dolby Laboratories Licensing Corporation.
High Dynamic Range (HDR) Grading in DaVinci Resolve

The HDR features found in DaVinci Resolve are only available in DaVinci Resolve Studio.

High Dynamic Range (HDR) video describes an emerging family of video encoding and distribution technologies designed to enable a new generation of television displays to play video capable of intensely bright highlights and increased saturation. The general idea is that the majority of an HDR image will be graded similarly to how a Standard Dynamic Range (SDR) image is graded now, with the shadows and midtones being mostly the same between traditionally SDR and HDR-graded images. This is mostly because shadows are shadows and are meant to be dark; however this philosophy also maintains a comfortable viewing experience and easier backward compatibility when you need to master both SDR and HDR versions of a program. The difference is that HDR provides abundant additional headroom for very bright highlights and color saturation that far exceed what has been previously visible in SDR television and cinema. This enables the colorist to create more vivid and life-like highlights in images, such as sunsets, lit clouds, firelight, explosions, sparkles, and other intensely bright and colorful imagery. In short, you can now “open up” the highlights in an image just as you’ve always been able to open up, or expand, the detail of the shadows. This not only provides more life-like lighting intensity and saturation, but it also dramatically expands the contrast available in the scene. For example, a calibrated SDR display should have a peak luminance level of 100 nits (cd/m²), but existing HDR displays can provide peak luminance levels of 700, 1000, or even 4000 nits.
However, because it’s an evolving technology, the technical standards that have been developed far exceed what current consumer televisions, projectors, phones, and tablets are capable of. At the time of this writing, consumer televisions are capable of outputting 700 to 1600 nits. Furthermore, consumer displays are often saddled with automatic brightness limiting (ABL) circuits that limit power consumption to acceptable levels for home use, which means that only a certain percentage of the picture may reach these peak values at any one time. This is fine, because the point of HDR is not that you’re making the entire image brighter, it’s that you have more headroom for specific bright highlights and additional saturation.

For all of these reasons, HDR standards focus on describing what displays should be capable of, not how these levels are to be used. That is a creative decision.

**HDR Isn’t Just for Televisions**

Lest you think that living room televisions and projectors are the only way to watch HDR content, certain flagship iOS and Android phones and tablets have implemented HDR viewing capabilities that are capable of meeting or even exceeding the UltraHD requirements for HDR content on an OLED display. This makes HDR, surprisingly, a widely available mobile experience.

**The Different Ways of Mastering HDR**

While different HDR technologies use different methods to map the video levels of your program to an HDR display’s capabilities, they all output a “near-logarithmically” encoded signal that requires a compatible television that’s capable of correctly stretching this signal into its “normalized” form for viewing. This means if you look at an HDR signal that’s output from the video interface of your grading workstation on an SDR display, it will look flat, desaturated, and unappealing until it’s plugged into your HDR display of choice.

A graded HDR image being output looks similar to a log-encoded image

At the time of this writing, there are four principal approaches to mastering HDR that DaVinci Resolve is capable of supporting, including:

- Dolby Vision®
- HDR10
- HDR10+
- Hybrid Log-Gamma (HLG)

Each of these HDR standards define how an HDR signal is encoded for export and later mapped to the visible output of an HDR or SDR display. Grading to each of these standards requires some degree of color management, and DaVinci Resolve gives you three main ways to handle this:

- The easiest way is to enable Resolve Color Management (RCM) or ACES in the Color Management panel of the Project Settings, and use the Color Space conversion options that are available. There are options there for each supported type of HDR.
– The transforms that are available in RCM are also available as Resolve FX operations, if you want to organize your grading pipeline more manually using the Color Transform Resolve FX adjustment.

– LUTs are also available to accomplish each of these color space conversions if you want to develop your own specific image processing pipeline based on custom-made LUT or DCTL transforms.

Overall, Resolve Color Management and ACES are reliable and recommended approaches to handling HDR grading in DaVinci Resolve in most instances. For more information about Resolve Color Management, see Chapter 8, “Data Levels, Color Management, and ACES.”

What Do I Do With HDR?

While these standards make HDR mastering and distribution possible, they have nothing to say about how these HDR-strength levels should be used creatively. That’s up to you, because the question of how to utilize the expansive headroom for brightness and saturation that HDR enables is fully within the domain of the colorist, as a series of creative decisions that must be made regarding how to assign the range of highlights that are available in your source media to the above-100 nit HDR levels you’re mastering to as you grade, given the peak luminance level that you’re assigned to master with. Which HDR peak luminance level you use (1000 nit, 3000 nit, 4000 nit) probably depends on which display you have access to and who’s distributing the resulting program.

Analyzing HDR Signals Using Video Scopes

When you’re using waveform scopes of any kind, including parade and overlay scopes, the signal will fit within the 10-bit scale used to analyze the signal much differently owing to the way HDR is encoded. The following chart of values will make it easier to understand how each level in “nits” (i.e., cd/m²) corresponds to a code value within the 10-bit image scale:

<table>
<thead>
<tr>
<th>10-Bit Code</th>
<th>Nearest Value in cd/m²</th>
<th>HDR Display Peak Luminance Capability</th>
</tr>
</thead>
<tbody>
<tr>
<td>1019†</td>
<td>10,000</td>
<td>No commercially available display</td>
</tr>
<tr>
<td>920</td>
<td>4000</td>
<td>Dolby Pulsar</td>
</tr>
<tr>
<td>889</td>
<td>3000</td>
<td>Flanders Scientific XM310K w/L20 test pattern</td>
</tr>
<tr>
<td>844</td>
<td>2000</td>
<td>Dolby PRM 32FHD</td>
</tr>
<tr>
<td>767</td>
<td>1000</td>
<td>Sony BVM X300 w/L10 test pattern, EIZO Prominence CG3145, or Flanders Scientific XM311K</td>
</tr>
<tr>
<td>756</td>
<td>900</td>
<td>Flanders Scientific XM650U w/L20 test pattern</td>
</tr>
<tr>
<td>742</td>
<td>800</td>
<td>Panasonic TC-55FZ1000U w/L10 test pattern</td>
</tr>
<tr>
<td>728</td>
<td>700</td>
<td>Measured on an iPhone XS displaying 50% white</td>
</tr>
<tr>
<td>711</td>
<td>600</td>
<td>Canon V2411 (not in burst mode)</td>
</tr>
<tr>
<td>691</td>
<td>500</td>
<td>Minimum standard for an “UltraHD” OLED display</td>
</tr>
<tr>
<td>635</td>
<td>300</td>
<td>Flanders Scientific DM250 in “HDR preview mode” w/L40 pattern</td>
</tr>
<tr>
<td>593</td>
<td>203</td>
<td>BT.2408 recommendation for diffuse white of SDR content being intercut with 1000 nit max HDR content</td>
</tr>
<tr>
<td>528</td>
<td>108</td>
<td>Dolby Cinema projector</td>
</tr>
<tr>
<td>520</td>
<td>100</td>
<td>Standard peak luminance for SDR displays</td>
</tr>
<tr>
<td>447</td>
<td>48</td>
<td>Standard peak luminance for SDR DCI projection, Dolby Cinema 3D peak luminance</td>
</tr>
<tr>
<td>4†</td>
<td>0</td>
<td>Absolute black</td>
</tr>
</tbody>
</table>

† 0–3 and 1020–1023 are reserved values
While this table of values is useful for understanding where HDR nit levels fall on legacy external scopes, if you’re monitoring with the built-in video scopes in DaVinci Resolve, you can turn on the “Enable HDR Scopes for ST.2084” checkbox in the Color panel of the User Preferences, which replaces the 10-bit scale of the video scopes with a scale based on nit values (or cd/m²) instead.

The video scopes with “Enable HDR Scopes for ST.2084” enabled in the Color panel of the User Preferences

**TIP:** If you’re unsatisfied with the amount of detail you’re seeing in the 0–519 range (0–100 nits) of the video scope graphs, then you can use the 3D Scopes Lookup Table setting in the Color Management panel of the Project Settings to assign the appropriate “HDR X nits to Gamma 2.4 LUT,” with X being the peak nit level of the HDR display you’re using. This converts the way the scopes are drawn so that the 0–100 nit range of the signal takes up the entire range of the scopes, from 0 through 1023. This will push the HDR-strength highlights up past the top of the visible area of the scopes, making them invisible, but it will make it easier to see detail in the midtones of the image.

---

**Dolby Vision®**

Long a pioneer and champion of HDR for enhancing the consumer video experience, Dolby Laboratories has developed a method for mastering and delivering HDR called Dolby Vision. As with most HDR standards discussed in this chapter, Dolby Vision uses the PQ (perceptual quantizer) electrical-optical transfer function (EOTF, which defines how an electronic video signal is presented on a display), which is defined by SMPTE ST.2084, along with a hierarchy of metadata that’s embedded alongside the video stream. All metadata used by Dolby Vision is organized into levels, of which the following are important to the colorist:

- **Level 0 metadata**, which is global metadata that defines the Mastering Display (what the colorist is using), including aspect ratio, frame rate, color encoding and information on all the target displays that are used for the Level 2 and Level 8 trim metadata below.

- **Level 1 metadata**, which is the Dolby Vision v2.9 analysis metadata that’s generated automatically when you use the Dolby Vision controls to analyze the clips in the timeline. The controls for automatically generating Level 1 metadata are available to all DaVinci Resolve Studio users.
– Level 2 metadata, which is the Dolby Vision v2.9 trimming metadata that’s set by the colorist via the version 2.9 trim controls available in the Dolby Vision palette of the Color page. This trimming allows adjustment of how the Dolby Vision image is to be mapped to a target display (such as a 100 nit BT.709 display) that’s different from the mastering display (such as a 1000 nit BT.2020 display). The purpose of this metadata is to maintain a program’s artistic intent by providing guidance from the colorist over how the program’s signal should be fit into the differing luminance ranges of a variety of displays with different peak luminance capabilities. Manually adjustable Level 2 metadata is only available to DaVinci Resolve Studio users via a license obtained from Dolby.

– Level 3 metadata, which is the offset for Dolby Vision v4.0 added to Level 1 metadata generated by the analyze buttons in the Dolby Vision controls. It also stores the mid tone offset data.

– Level 5 metadata, which provides information about the aspect ratio of the deliverable format, and the aspect ratio of the actual image within that format. This metadata is also applicable at the per clip level.

– Level 6 metadata, which stores the MaxCLL and MaxFALL levels required by the HDR10 mastering standard of HDR.

– Level 8 metadata, which is the updated Dolby Vision v4.0 trimming metadata that’s set by the colorist via the v4.0 trim controls available in the Dolby Vision palette of the Color page. This evolved set of trimming commands allows more detailed adjustment of how the Dolby Vision image is to be mapped to a target display (such as a 100 nit BT.709 display) that’s different from the mastering display (such as a 1000 nit BT.2020 display). Just like Level 2 metadata, the purpose of Level 8 metadata is to maintain a program’s artistic intent by providing guidance from the colorist over how the program’s signal should be fit into the differing luminance ranges of a variety of displays with different peak luminance capabilities. Manually adjustable Level 8 metadata is only available to DaVinci Resolve Studio users via a license obtained from Dolby. Whether you use Level 2 trim controls or Level 8 trim controls depends on the Dolby Vision version setting you choose in the Color Management panel of the Project Settings.

**NOTE:** It’s currently recommended for all users to choose Dolby Vision v4.0 for analysis and trimming, as it provides superior results. If you’re required to deliver Dolby Vision v2.9 metadata when mastering for backwards compatibility, DaVinci Resolve can now export v2.9 metadata from projects using v4.0 workflows.

The metadata levels described above are current of this writing. However Dolby Vision is a rapidly evolving technology, and as Dolby adds new features and metadata levels you should reference Dolby’s website to keep track of the latest developments: [https://professionalsupport.dolby.com/s/article/Dolby-Vision-Metadata-Levels?language=en_US](https://professionalsupport.dolby.com/s/article/Dolby-Vision-Metadata-Levels?language=en_US)

For the foreseeable future, the current consumer display landscape encompasses a wide variety of differently performing televisions and projectors that are guaranteed to improve year over year. This means that mastering for today’s displays may render content less vibrant than content that emerges five years from now. This can be especially vexing for narrative content that will have a long lifespan on streaming services as new generations of viewers discover them. While one way of solving this would be to re-grade your program many times at a variety of nit levels to create deliverables suitable to a range of display capabilities, that’s an enormous amount of work.

Dolby Vision offers a shortcut by using sophisticated algorithms to derive automatically analyzed metadata that intelligently guides how an image graded at one nit level (say 4000 nits) can be adjusted to be perceptually similar to viewers watching a 1000 nit display. Highlights and saturation that are too bright for a particular display will be adjusted to provide as close to the same experience without clipping or flattening image detail.
Furthermore, this automatic analysis can be manually trimmed by a colorist to account for the artistic intentions of the authors of a program, in cases where the automatic analysis doesn’t do exactly what’s wanted. This combination of auto-analysis and manual trimming is key to how Dolby Vision streamlines the process of mastering programs to accommodate backward compatibility with SDR displays, as well as the varying peak luminance capabilities of different makes and models of HDR consumer displays, both now and in the future. You’re only required to make a 100 nit trim pass to guide the HDR program’s conversion all the way down to SDR, and the Dolby Vision system can use that information to guide how intermediate presentations (such as at 700 or 1200 nits) should be adjusted. You can even do multiple trim passes at specific nit levels, such as a 100 nit pass and a 1000 nit pass, to give the Dolby Vision system more information to accurately guide intermediate presentations on different displays. Additionally, you don’t have to trim every clip. If the analysis is good, you can skip those clips and only trim clips that need it. The overall system has been created to make it as efficient as possible for colorists to ensure that the widest variety of viewers see the image as it’s meant to be seen.

This, in a nutshell, is the advantage of the Dolby Vision system. You can grade a program on a more future-proofed 4000 nit display, and use auto-analysis plus one or two manual trim passes to make the program backward compatible with SDR televisions, and capable of intelligently scaling the HDR highlights to provide the best representation of the mastered image for whatever peak luminance and color volume a particular television is capable of. All of this is guided by decisions made by the colorist during the grade.

At the time of this writing, all seven major Hollywood studios are mastering in Dolby Vision for cinema. Studios that have pledged support to master content in Dolby Vision for home distribution include Universal, Warner Brothers, Sony Pictures, and MGM. Content providers that have agreed to distribute streaming Dolby Vision content include Netflix, Vudu, and Amazon. If you want to watch Dolby Vision content on television at home, consumer television manufacturers LG, TCL, Vizio, HiSense, Sony, Toshiba, and Bang & Olufsen have all shipped models with Dolby Vision support.

Organizing Your Timeline for Dolby Vision Mastering

One of the first things you need to do before doing a Dolby Vision grade is to organize your timeline accordingly. Because each clip undergoes a visual analysis to facilitate the Dolby Vision workflow, there are specific limitations to how clips can appear in a timeline.

– All clips to be analyzed in a Dolby Vision workflow need to be on video track V1; clips on other tracks will be ignored.
– All clips that overlap one another as part of a composite must be turned into a single item in the timeline in order to be correctly analyzed. This means that each group of clips that create a composite in a timeline, be it multiple overlapping clips combined via keys or alpha channel transparency, multiple overlapping clips combined using composite or blend modes, or text generators appearing above one or more video clips, must be turned into a compound clip for Dolby Vision analysis to work correctly.

Letterboxing for Dolby Vision Mastering

The analysis of clips in a Dolby Vision workflow keeps track of the timeline aspect ratio, as well as the image aspect ratio of each clip in that timeline. Programs that mix different aspect ratios of letterboxing (or blanking) will be accommodated by the Dolby Vision analysis, however Dolby Vision does not support letterbox on two sides (both pillarbox and letterbox), only one at a time.

If you choose Show Blanking Clip Override in the Output Sizing mode of the Sizing palette, you have the option of overriding the overall Timeline Blanking settings with individual Clip Blanking settings. You can do this by choosing the Clip option and then turning off the Use Timeline Blanking checkbox. At this point, you can choose any letterboxing format you want, and the correct letterboxing ratio will be stored as part of the metadata.
Setting Up Color Management for Dolby Vision Mastering

For an HDR signal to look correct, you need to output your graded program using the right EOTF for the HDR standard you’re mastering. The EOTF maps the different levels DaVinci Resolve outputs to your HDR display using the SMPTE ST.2084 PQ setting required for outputting Dolby Vision. You can set this up in one of three different ways, as:

– Output Color Space and Gamma settings in RCM or ACES
– Color Space and Gamma settings within a series of Resolve FX Color Transform plug-ins that can be used at the end of each grade or at the end of a Timeline grade
– 3D LUTs used for converting signals from one standard to another that can be used at the end of each grade or at the end of a Timeline grade

While Dolby Vision content is not limited to a particular color space, Resolve Color Management provides a P3 D65 setting that matches the capabilities of most mastering displays in use at the time of this writing.

Choosing Mastering Displays for Dolby Vision

To do HDR grading, you need a suitable HDR display. Technically any monitor that supports SMPTE ST.2084 (aka PQ) will work. Happily, a growing number of professional displays from Sony, Flanders Scientific, TV-Logic, Canon, and Eizo are suitable for use in HDR grading suites. EBU Tech 3320 specifies the requirements for a Grade 1 HDR mastering monitor. Dolby recommends the following minimum requirements for HDR monitors:

– A minimum Peak Luminance of 1000 nits
– A 200,000:1 contrast ratio
– Minimum black at 0.005 nits
– Capable of at least 99% of P3 gamut


Using the Dolby Vision Internal Content Mapping Unit (iCMU)

DaVinci Resolve has a GPU-accelerated “internal” software version of the Dolby Vision CMU (Content Mapping Unit) for previewing Dolby Vision mapping right in DaVinci Resolve. iCMU support can be enabled and set up in the Color Management panel of the Project Settings by turning on the Enable Dolby Vision checkbox. This is a DaVinci Resolve Studio-only feature.
The Dolby Vision group of settings also exposes menus for choosing the version of Dolby Vision you want to use, what kind of Master Display you’re using, and whether or not to use an eCMU (assuming you possess the option). Finally, turning Dolby Vision on also enables the Dolby Vision palette and controls in the Color page, which are described in greater detail later in this chapter.

To master with Dolby Vision in DaVinci Resolve using the built-in iCMU, you still need a more specific hardware setup than the average grading and finishing workstation, consisting of the following equipment:

– Your DaVinci Resolve grading workstation, outputting via either a DeckLink 8K Pro or DeckLink 4K Extreme 12G video interface

– A mastering display capable of outputting HDR nit levels suitable for the deliverable you’re required to produce

**Simultaneous Master and Target Display Output for Dolby Vision**

When mastering HDR and trimming versions for more limited displays, it’s extremely useful to be able to evaluate your HDR grade and SDR trim pass side-by-side. It’s possible to output both the Master Display output and the Target Display output simultaneously when you’re grading with either Dolby Vision or HDR10+ enabled.

**Necessary Hardware**

To work in this manner, you must have the following equipment:

– Your DaVinci Resolve grading workstation must output via a DeckLink 8K Pro or DeckLink 4K Extreme 12G.

– Your Mastering Display must be capable of HDR nit levels suitable for the deliverable you’re required to produce.

– A display that can be set to output calibrated SDR, probably using the BT.709 gamut

**Enabling Simultaneous Monitoring**

When you set up your display hardware, the HDR Master Display must be connected to output A, and the Target Display must be connected to output B of whichever BMD video output device you’re using. Then, you need to turn on the “Use dual outputs on SDI” checkbox in the Master Settings of the Project Settings. At this point, assuming all of your connections are compatible with one another, you should see an HDR image output to your HDR display, and a trimmed image output to your SDR display.

**External Content Mapping Unit (eCMU) for Dolby Vision**

DaVinci Resolve supports the use of a Dolby External Content Mapping Unit (eCMU) for studios doing more intensive HDR mastering work, as it lets you monitor and adjust an HDR display simultaneously to an SDR display for side-by-side trimming at high resolutions via hardware. The eCMU also has the ability to preview Dolby Vision on a consumer display in real time via HDMI tunneling to view directly what the audience will see at home.
Auto Analysis is Available to All Studio Users

Resolve Studio enables either unlicensed or licensed users to automatically analyze the image and generate Dolby Vision analysis metadata. This metadata is used to deliver Dolby Vision content and to render other HDR and SDR deliverables from the HDR grade that you’ve made. This enables any DaVinci Resolve Studio user to create Dolby Vision deliverables with Level 1 metadata. However, manual trimming of the analysis metadata requires a license from Dolby.

The commands governing Dolby Vision auto-analysis, which are available to all Resolve Studio users, are available in the Color > Dolby Vision™ submenu, as well as the Dolby Vision palette, and consist of the following:

- **Analyze All Shots**: Automatically analyzes each clip in the Timeline and stores the results individually.
- **Analyze Selected Shot(s)**: Only analyzes selected shots in the Timeline.
- **Analyze Selected And Blend**: Analyzes multiple selected shots as if they were a single sequence. The result is the same analysis being saved to each clip. Useful to save time when analyzing multiple clips that have identical content.
- **Analyze Current Frame**: A fast way to analyze clips where a single frame is representative of the entire shot.

Once you analyze a clip, the Min, Max, and Average fields automatically populate with the resulting L1 data; these fields are not editable.

The metadata fields for each clip

Additionally, clips that have been analyzed show an HDR badge in the Thumbnail timeline, to help you keep track of which clips have been analyzed and which have yet to be.

Licensing DaVinci Resolve to Expose Dolby Vision Trim Controls

To expose the Dolby Vision controls in DaVinci Resolve Studio that let you make manual trims on top of the automatic analysis that any copy of DaVinci Resolve Studio can do, you must email dolbyvisionmastering@dolby.com to receive more information about obtaining a license.

Once you’ve obtained a license file from Dolby, you can import it by choosing File > Dolby Vision > Load License, and its successful installation will enable the Dolby Vision controls to be enabled in the Color page. You should also receive a display configuration file, which can be loaded via the File > Dolby Vision > Load Configuration command and lets you populate the Dolby Vision drop-down menus with the most up to date options.
Dolby Vision Trim Controls in DaVinci Resolve

Once you’ve analyzed a clip, you’re in a position to trim the result. The latest version of the Dolby Vision palette exposes four sets of controls. The first are the main controls:

- **Target Display Output**: This drop-down specifies what Dolby refers to as the Target Display, used to display the tone mapped image. This menu lets you choose specific display properties to obtain a preview of what the trimmed image will look like on different displays with different gamuts and peak luminance capabilities.

- **Trim Controls for**: Which Target Display you’re currently trimming for. The default setting (100-nit, BT.709, BT.1886, Full) lets you monitor an SDR version of the HDR image, so you can see how the trim metadata tone maps the image on non-HDR televisions.

- **Analyze controls**: The commands governing Dolby Vision auto-analysis are available as buttons, which perform the same functions as their similarly named counterparts in the Color > Dolby Vision submenu. Please note that most trim controls are disabled until you perform an analysis, which is a necessary first step.
  - **All**: Automatically analyzes each clip in the current Timeline and stores the results individually.
  - **Selected**: Only analyzes selected shots in the Timeline.
  - **Blend**: Analyzes multiple selected shots as if they were a single sequence. The result is the same analysis being saved to each clip. You need to use the blend option when analyzing two clips that meet at a through edit separating otherwise contiguous frames. It’s also typical to use the Blend option when analyzing a scene of clips that take place at the same location at the same time, to ensure that natural variations in lighting don’t add unwanted variations between the analyses of clips that are supposed to already be balanced with one another. Blend also saves time when analyzing multiple clips that have identical content.
  - **Frame**: Useful in situations where part of a clip has an extreme level of color or lightness that’s not typical of the rest of the clip, that incorrectly biases the analysis and produces a poor result. Placing the playhead on a frame that’s representative of how the clip is supposed to look and using the Frame option bases the analysis on only that frame. This is also a fast way to analyze clips where a single frame is representative of the entire shot.

- **Enable Tone Mapping Preview**: Lets you see the target display output in the Color page Viewer and video output, so you can evaluate how the tone mapped version looks on your HDR display. This control is disabled when you enable “Use dual-outputs on SDI” in the Master Settings of the Project Settings, since the second output SDI now automatically displays the target display output.

- **Mid Tone Offset (CM v4.0 only)**: This control is used to match the overall exposure between the tone mapped SDR signal to the HDR master. This offset is applied to the L1 Mid values, allowing the adjustment of mid tones without affecting the blacks and highlights. It can be used to shift overall L1 analysis to ensure the best preservation of artistic intent. This setting is shared among all trim passes you do at all nit levels, so if you’ve done two trim passes, one at 100 nits and another at 1000 nits, adjusting this setting always adjusts both trim passes at once. Changes made to this control are recorded to the L3 metadata for each clip.

The second are the Min, Mid, and Max metadata fields that are populated by the analyzed values of the current clip. These fields cannot be edited, although analysis metadata can be copied and pasted among clips. These values represent the L1 analysis and are used to calculate how the HDR image should be trimmed to fit into the video standard specified by the Target Display.

The third are the Primary Trims, which are only editable if you’ve performed an analysis and if you have a license from Dolby. Which controls are exposed depends on the version of Dolby Vision you’ve selected in the Color Management panel of the Project Settings.
Dolby Vision CM v2.9 Controls
If you choose Dolby Vision 2.9 in the Color Management panel of the Project Settings, it activates the 2.9 version of Dolby’s content mapping algorithm and exposes the original Dolby Vision trim controls. It is no longer suggested to use these, since you can do a Dolby Vision 4.0 analysis and trim, and still export converted 2.9 metadata for legacy workflows.

- **Lift/Gamma/Gain**: These controls function similarly to the Y-only Lift, Gamma, and Gain master wheels of the Color Wheels palette, to let you trim the overall contrast levels of the image. The Dolby Best Practices Guide recommends to limit positive Lift to no more than 0.025, and mostly restrict yourself to using Gamma and Gain if necessary to lighten the image.

- **Saturation Gain**: Lets you trim the saturation of the most highly saturated areas within a scene. Lesser saturated values will be less affected.

- **Chroma Weight**: Darkens saturated parts of the image to preserve colorfulness in areas of the image that are clipped by smaller gamuts that don’t have enough headroom for saturation in the highlights.

- **Tone Detail**: Lets you preserve contrast detail in the highlights that might otherwise be lost when the highlights are mapped to lower dynamic ranges, usually due to clipping. Increasing Tone Detail Weight increases the amount of highlight detail that’s preserved. When used, can have the effect of sharpening highlight detail.

Dolby Vision CM v4.0 Controls
If you choose Dolby Vision 4.0 in the Color Management panel of the Project Settings, it activates the 4.0 version of Dolby’s content mapping algorithm, and exposes the following controls.

- **Lift/Gamma/Gain**: These controls function similarly to the Y-only Lift, Gamma, and Gain master wheels of the Color Wheels palette, to let you trim the overall contrast levels of the image. The Dolby Best Practices Guide recommends to limit positive Lift to no more than 0.025, and mostly restrict yourself to using Gamma and Gain if necessary to lighten the image.

- **Saturation Gain**: Lets you trim the saturation of the most highly saturated areas within a scene. Lesser saturated values will be less affected.

- **Chroma Weight**: Darkens saturated parts of the image to preserve colorfulness in areas of the image that are clipped by smaller gamuts that don’t have enough headroom for saturation in the highlights.

- **Tone Detail**: Lets you preserve contrast detail in the highlights that might otherwise be lost when the highlights are mapped to lower dynamic ranges, usually due to clipping. Increasing Tone Detail Weight increases the amount of highlight detail that’s preserved. When used, can have the effect of sharpening highlight detail.

- **Mid Contrast Bias**: Affects image contrast in the region around the computed average picture level. This lets you increase or decrease contrast in the midtones of the image.

- **Highlight Clipping**: Reduces details and affects the roll-off the brighter part of the image by clipping the highlights as required. This is useful when the tone mapped image is displaying unwanted details.
The Primary Trims controls that are found in the Dolby Vision palette are only enabled once you’ve authorized your system with a special license, available from Dolby.

The fourth set of controls is available via a second palette mode, the Secondary Trims. These are only editable if you’ve performed an analysis and if you have a license from Dolby.

- **Secondary Saturations**: A set of slider-based vector-style controls (similar to the Hue vs. Sat curve) lets you adjust the Saturation of Red, Yellow, Green, Cyan, Blue, and Magenta to help you selectively fine tune the results.

- **Secondary Hues**: Another set of slider-based vector-style controls (similar to the Hue vs. Hue controls) lets you adjust the Hue of Red, Yellow, Green, Cyan, Blue, and Magenta to help you fine tune the results.

Together, all of this trimming metadata lets the colorist guide how the iCMU or eCMU transforms the image from the Mastering Display specified in the Project Settings to the Target Display specified in the Dolby Vision palette. This metadata is carried throughout the ecosystem so that your artistic intent is preserved on a variety of platforms and displays.

### Previewing and Trimming At Different Levels

Additionally, the iCMU or eCMU can be used to preview 100 nit, 600 nit, 1000 nit, and 2000 nit versions of your program, with different gamuts, if you want to see how your master will scale to those combinations of peak luminance levels and standards. This, of course, requires your DaVinci Resolve workstation or eCMU to be connected to a display that’s capable of being set to those peak luminance output levels.

Though it’s not at all typical, you also have the option to set the “Trim Controls For” drop-down menu to different combinations of peak luminance, gamut, and color temperature, in order to visually trim the grades of your program at up to four different peak luminance levels, including 100 nit, 600 nit, 1000 nit, and 2000 nit reference points. Choosing a setting from the “Trim Controls For” drop-down menu sets you up to adjust trim metadata for that setting.
Choosing different settings from the “Trim Controls For” drop-down menu lets you can optimize a program’s visuals for the peak luminance and color volume performance of many different televisions with a much finer degree of control. If you take this extra step of doing a complete trim pass of your program at multiple nit levels (using the Dolby Vision controls), the Level 2, or Level 8 metadata you generate in each trim pass ensures that the artistic intent is preserved as closely as possible across a wide variety of displays, in an attempt to provide the viewer with the best possible representation of the director’s intent, no matter where it appears.

For example, if a program were graded relative to a 4000 nit display, along with a single 100 nit BT.709 trim pass, then a Dolby Vision-compatible television with 750 nit peak output will reference the 100 nit trim pass metadata in order to come up with the best way of “splitting the difference” to output the signal correctly. On the other hand, were the colorist to do three trim passes, the first at 100 nits, a cond at 600 nits, and a third at 1000 nits, then a 750 nit-capable Dolby Vision television would be able to use the 600 and 1000 nit trim metadata to output more accurately scaled color volume and HDR-strength highlights, relative to the colorist’s adjustments, that take better advantage of the 750 nit output of that television.

Managing Dolby Vision Metadata

As you go through the process of analyzing and trimming the HDR grades displayed on your Master Display to look appropriate on your Target Display, you’ll sometimes find it useful to copy and paste metadata from one clip to another. You can copy and paste Analysis Metadata separately from Trim Metadata and Mid Tone Offset, and you can choose to copy and paste metadata for all Target Displays when you’re trimming multiple passes, or you can copy and paste metadata for only the current Target Display if you’re trimming multiple passes and you only want to overwrite metadata for a single pass.

Methods of Copying and Pasting Dolby Vision Metadata:

– **To copy and paste Analysis Metadata:** Select a clip you want to copy from, choose Copy Analysis Metadata from the Dolby Vision palette option menu, then select a clip you want to paste to, and choose Paste Analysis Metadata from the Dolby Vision palette option menu.

– **To copy and paste Trim Metadata for all Target Displays:** Do one of the following:
  – Select a clip you want to copy from, choose Edit > Dolby Vision > Copy Trim Metadata, then select a clip you want to paste to, and choose Edit > Dolby Vision > Paste Trim Metadata.
  
  – Select a clip you want to copy from, choose Copy Trim Metadata from the Dolby Vision palette option menu, then select a clip you want to paste to, and choose Paste Trim Metadata from the Dolby Vision palette option menu.

  – Select a clip you want to paste to, then press and hold the Option-Shift keys, and middle-click the clip you want to copy from.

– **To copy and paste Trim Metadata for the current Target Display:** Do one of the following:
  – Select a clip you want to copy from, choose Copy Trim Metadata from the Dolby Vision palette option menu, then select a clip you want to paste to, and choose Paste Trim Metadata to Current from the Dolby Vision palette option menu.

  – Select a clip you want to paste to, then press and hold the Option key, and middle-click the clip you want to copy from.

– **To copy and paste Mid Tone Offset:** Select a clip you want to copy from, choose Copy Mid Tone Offset from the Dolby Vision palette option menu, then select a clip you want to paste to, and choose Paste Mid Tone Offset from the Dolby Vision palette option menu.
Setting Up Resolve Color Management for Grading HDR

Once the hardware is set up, setting up Resolve itself to output HDR for Dolby Vision mastering is easy using Resolve Color Management (RCM). This procedure is pretty much the same no matter which HDR mastering technology you’re using; only specific Output Color Space settings will differ.

1. Set Color Science to DaVinci YRGB Color Managed in the Color Management panel of the Project Settings.

2. Then, open the Color Management panel, and set the Output Color Space drop-down to the ST.2084 setting that corresponds to the peak luminance, in nits, of the grading display you’re using. For example, if you’re grading with a Sony BVM X300, choose ST.2084 1000 nit, but if you’re grading with a Flanders Scientific XM310K, choose ST.2084 3000 nit, in order to use the full capabilities of each display. Be aware that whichever HDR setting you choose will impose a hard clip at the maximum nit value supported by that setting. This is to prevent accidentally overdriving HDR displays for which there are negative consequences (not all HDR displays have this limitation).

   - ST.2084 300 nit
   - ST.2084 500 nit
   - ST.2084 800 nit
   - ST.2084 1000 nit
   - ST.2084 2000 nit
   - ST.2084 3000 nit
   - ST.2084 4000 nit

   This setting is only the output EOTF (a sort of gamma transform, if you will, using the terminology that DaVinci Resolve’s UI has used up until now).

3. Next, choose a setting in the Timeline Color Space that corresponds to the gamut you want to use for grading, and that will be output. For example, if you want to grade the Timeline as a log-encoded signal and “normalize” it yourself, you can choose ARRI Log C or Cineon Film Log (this workflow is highly recommended for the best results). If you would rather save time by having DaVinci Resolve normalize the Timeline to P3-D65 and grade that way, you can choose that setting as well. In terms of defining the output gamut, the rule is that if “Use Separate Color Space and Gamma” is turned off, the Timeline Color Space setting will define your output gamut. If “Use Separate Color Space and Gamma” is turned on, then you can specify whatever gamut you want in the left Output Color Space drop-down menu, and choose the EOTF from the right drop-down menu (as described in step 2).

4. Be aware that, when it’s being properly output, HDR ST.2084 signals appear very “log-like,” in order to pack a wide dynamic range into the bandwidth of a standard video signal. It’s the HDR display itself that “normalizes” this log-encoded image to look as it should. For this reason, the image you see in your Color page Viewer is going to appear flat and log-like, even though the image being displayed on your HDR reference display looks vivid and correct. If you’re using a typical SDR computer display, and you want to make the image in the Color Page Viewer look “normalized” at the expense of clipping the HDR highlights (in the Viewer, not in the grade), you can use the 3D Color Viewer Lookup Table setting in the Color Management panel of the Project Settings to assign the appropriate ST.2084 setting with a peak nit level that corresponds to the HDR broadcast display you’re outputting to.

5. Additionally, the “Timeline resolution” and “Pixel aspect ratio” (in the project settings) that your project is set to use is saved to the Dolby Vision metadata, so make sure your project is set to the final Timeline resolution and PAR before you begin grading.
DaVinci Resolve Grading Workflow For Dolby Vision

Once the hardware and software is all set up, you’re ready to begin grading HDR. The workflow is fairly straightforward.

1. First, grade the HDR image on your HDR Monitor to look as you want it to. Dolby recommends starting by setting the look of the HDR image, to set the overall intention for the grade.

2. When using various grading controls in the Color page to grade HDR images, you may find it useful to enable the HDR Mode of the node you’re working on by right-clicking that node in the Node Editor and choosing HDR Mode from the contextual menu. This setting adapts that node’s controls to work within an expanded HDR range. Practically speaking, this makes controls that operate by letting you make adjustments at different tonal ranges, such as Custom Curves, Soft Clip, and so on, work more easily with wide-latitude signals.

3. When you’re happy with the HDR grade, click the Analysis button in the Dolby Vision palette. This analyzes every pixel of every frame of the current shot, and performs and stores a statistical analysis that is sent to the iCMU or eCMU to guide its automatic conversion of the HDR signal to an SDR signal.

4. Choose “Target Display Output” and “Trim Controls For” settings that you want to trim to. By default, these are set to “100-nit, BT.709, BT.1886, Full,” which is a typical SDR deliverable. However, other options are available if you want to do multiple trim passes to obtain a more accurate result. Whichever setting you choose from, “Trim Controls For” dictates which trim pass you’re doing. You can do multiple trim passes by choosing another option from this menu.

5. If you’re not happy with the automatic conversion, use the trim controls in the Dolby Vision palette to manually trim the result to the best possible BT.709 approximation of the HDR grade you created in step 1.

6. If you obtain a good result, then move on to the next shot and continue work. If you cannot obtain a good result, and worry that you may have gone too far with your HDR grade to derive an acceptable SDR tone mapping, you can always trim the HDR grade a bit, and then retrim the SDR grade to try and achieve a better tone mapping. Dolby recommends that if you make significant changes to the HDR master, particularly if you modify the blacks or the peak highlights, you should reanalyze the scene. However, if you only make small changes, then reanalyzing is not strictly required.

As you can see, the general idea promoted by Dolby is that a colorist will focus on grading the HDR picture relative to the 1000, 2000, 4000, or higher nit display that is being used, and will then rely on the colorist to use the Dolby Vision controls to “trim” this into a 100 nit SDR version. This metadata is saved as part of the mastered media, and it’s used to more intelligently tone map the entire image to fit within any given display’s parameters. The colorist’s artistic intent is used to guide all dynamic adjustments to the content.

Delivering Dolby Vision

Once you’re finished grading the HDR and trimming the SDR tone mapping, you need to output your program correctly in the Deliver page.

Rendering a Dolby Vision Master

To deliver a Dolby Vision master after you’ve finished grading, you want make sure that the Output Color Space of the Color Management panel of the Project Settings is set to the appropriate HDR ST.2084 setting based on the peak output you want to deliver (any values above will be clipped). Then, you want to set your render up to use one of the following Format/Codec combinations:

- TIFF, RGB 16-bit
- EXR, RBG-half (no compression)
When you render for tapeless delivery, all Dolby Vision metadata is recorded into a Dolby Vision XML and delivered along side either the Tiffs or EXR renders. To export a Dolby Vision XML file, select your timeline in the media pool and choose File > Export >Timeline. Navigate to where you want to save the file and select Dolby Vision v2.9 (or v4.0) MXF files from the file type selector and click save. These two sets of files are then delivered to a facility that’s capable of creating the Dolby Vision deliverable file.

Rendering a Dolby Vision IMF

You can deliver directly to an IMF that includes an MXF with embedded Dolby Vision metadata in the package. To export a Dolby Vision IMF use the following Video settings in the Deliver page:

- **Format:** IMF
- **Codec:** Kakadu JPEG 2000
- **Type:** Dolby Vision (HD, 2K, UHD, or 4K) depending on your deliverable resolution.

Configure the rest of the IMF settings as necessary for your project.

Rendering an Ordinary SDR Media File or Other Specific HDR Trim Pass

If you want to export the SDR trim pass, then you can choose Dolby Vision from the Tone Mapping drop-down menu in the Advanced Settings of the Render Settings list on the Deliver page, and choose the 100-nit, BT.709, BT.1886, Full setting below. With this enabled, you can output the SDR version of your program to any format you like.

You can also export the trims for other HDR nit levels for specific displays, at 600, 1000 or 2000 nits and in the either the BT.2020 or P3 gamuts.

SMPTE ST.2084 and HDR10

Many display manufacturers who have no interest in licensing Dolby Vision for inclusion in their displays are instead going with the simpler method of engineering their displays to be compatible with SMPTE ST.2084. It requires only a single stream for distribution, there are no licensing fees, no special hardware is required to master for it (other than an HDR mastering display), and there’s no special metadata to write or deal with.

Interestingly, SMPTE ST.2084 ratifies the “PQ” EOTF that was originally developed by Dolby, and which is used by Dolby Vision, into a general standard that accommodates encoding HDR at peak luminance values up to 10,000 cd/m². This standard requires at minimum a 10-bit signal for distribution, and the EOTF is mathematically described such that the video signal utilizes the available code values of a 10-bit signal as efficiently as possible, while allowing for such a wide range of luminance in the image.
SMPTE ST.2084 is also part of the "Ultra HD Premium" industry specification, which stipulates that televisions bearing the Ultra HD Premium logo have the following capabilities:

- A minimum UHD resolution of 3840 x 2160
- A minimum gamut of 90% of P3
- A minimum dynamic range of either 0.05 nits black to 1000 nits peak luminance (to accommodate LCD displays), or 0.0005 nits black to 540 nits peak luminance (to accommodate OLED displays)
- Compatibility with SMPTE ST.2084

Finally, ST.2084 has been included in the HDR 10 standard adopted by the Blu-ray Disc Association (BDA) that covers Ultra HD Blu-ray. HDR 10 stipulates that Ultra HD Blu-ray discs have the following characteristics:

- UHD resolution of 3840 x 2160
- Up to the Rec. 2020 gamut
- SMPTE ST.2084
- Mastered with a peak luminance of 1000 nits

The downside is that, by itself, an HDR10 mastered program is not backward compatible with BT.709 displays using BT.1886 (although the emerging HDR10+ standard described later addresses this). Furthermore, no provision is made to scale the above-100 nit portion of the image to accommodate different displays with differing peak luminance levels. For example, if you grade and master an image to have peak luminance of 4000 nits, and you play that signal on an HDR10-compatible television (using ST.2084) that’s only capable of 800 nits, then everything above 800 nits will be clipped, while everything below 800 nits will look exactly as it should relative to your grade.

This is because ST.2084 is referenced to absolute luminance. If you grade an HDR image referencing a 1000 nit peak luminance display, as is recommended by HDR10, then any display using ST.2084 will respect and reproduce all levels from the HDR signal that it’s capable of reproducing as you graded them, up to the maximum peak luminance level it can reproduce. For example, on an HDR10-compatible television capable of outputting 500 nits, all mastered levels from 501–1000 will be clipped, as seen in the screenshot below.

Comparing the original 1000 nit waveform representing the grading monitor to a 500 nit clipped waveform representing the consumer television.
How much of a problem this is really depends on how you choose to grade your HDR-strength highlights. If you’re only raising the most extreme peak highlights to maximum HDR-strength levels, then it’s entirely possible that the audience might not notice that the display is only outputting 800 nits worth of signal and clipping any image details from 801–1000 nits because there weren’t that many details above 800 anyway. Or, if you’re grading large explosive fireballs up above 800 nits in their entirety because it looks cool, then maybe the audience will notice. The bottom line is, when you’re grading for displays that are only capable of ST.2084, you need to think about these sorts of things.

**Monitoring and Grading to ST.2084 in DaVinci Resolve**

Monitoring an ST.2084 image is as simple as obtaining a ST.2084-compatible HDR display and connecting it to the output of your DeckLink 8K, DeckLink 4K Extreme 12G, or UltraStudio 4K Extreme.

Setting up Resolve Color Management to grade for ST.2084 is identical to setting up to grade for Dolby Vision. You’ll also monitor the video scopes identically, and output a master identically, given that both standards rely upon the same PQ curve.

**TIP:** If you’re monitoring with the built-in video scopes in DaVinci Resolve, you can turn on the “Enable HDR Scopes for ST.2084” checkbox in the Color panel of the User Preferences, which will replace the 10-bit scale of the video scopes with a scale based on nit values (cd/m²) instead.

**Connecting to HDR-Capable Displays using HDMI 2.0a**

If you have a DeckLink 4K Extreme 12G or an UltraStudio 4K Extreme video interface, then DaVinci Resolve 12.5 and above can output the metadata necessary to correctly display HDR video signals to display devices using HDMI 2.0a when you turn on the “Enable HDR metadata over HDMI” checkbox in the Master Settings panel of the Project Settings.

The “Enable HDR metadata over HDMI” option in the Master Settings panel of the Project Settings lets you output HDR via HDMI 2.0a.

When you do so, a setting in the Color Management panel of the Project Settings, “HDR mastering is for X” lets you specify the output, in nits, to be inserted as metadata into the HDMI stream being output, so that the display you’re connecting to correctly interprets it. The output you specify should match what your display is expecting.

The “HDR mastering is for” setting lets you insert metadata for HDR output via HDMI 2.0a.
DaVinci Resolve supports the new HDR10+ HDR format by Samsung. Please note that this support is a work in progress as this is a new standard. When enabled, an HDR10+ palette shows the results of the trimming analysis that make an automated downconversion of HDR to SDR, creating metadata to control how HDR-strength highlights look on a variety of supported televisions and displays. This is enabled and set up in the Color Management panel of the Project Settings with the Enable HDR10+ checkbox. Turning HDR10+ on enables the HDR 10+ palette in the Color page.

HDR10+ settings in the Color Management panel of the Project Settings

Monitoring and Grading to ST.2084 for HDR10+

When you’re grading a program for HDR10+ output, you’ll need to monitor an ST.2084 image, which is as simple as obtaining a ST.2084-compatible HDR display and connecting it to the output of your DeckLink 8K, DeckLink 4K Extreme 12G, or UltraStudio 4K Extreme.

Setting up Resolve Color Management to grade for ST.2084 is identical to setting up to grade for Dolby Vision or regular HDR10. You’ll also monitor the video scopes identically, and output a master identically, given that each of these standards rely upon the same PQ curve.

**TIP:** If you’re monitoring with the built-in video scopes in DaVinci Resolve, you can turn on the “Enable HDR Scopes for ST.2084” checkbox in the Color panel of the User Preferences, which will replace the 10-bit scale of the video scopes with a scale based on nit values (cd/m²) instead.

HDR10+ Grading Workflow

The idea behind the HDR10+ workflow is that you’ll grade the HDR version of each clip in your program first, and then use the automatic analysis to create a downconverted tone mapped version of each shot that’s controlled by metadata. Once the HDR10+ trim pass is complete, you’ll deliver the rendered HDR output along with a set of HDR10+ JSON metadata files to a facility for final mastering.

Simultaneous Master and Target Display Output for HDR10+

When mastering HDR and trimming versions for more limited displays, it’s extremely useful to be able to evaluate your HDR grade and tone mapped trim pass side by side. Starting in DaVinci Resolve 15, it’s possible to output both the Master Display output and the Target Display output simultaneously when you’re grading with either Dolby Vision or HDR10+ enabled.

Necessary Hardware

To work in this manner, you must have the following equipment:

- Your DaVinci Resolve grading workstation must output via a DeckLink 8K, DeckLink 4K Extreme 12G, UltraStudio 4K Extreme video interface, or better.
- Your Mastering Display must be capable of HDR nit levels suitable for the deliverable you’re required to produce.
- An HDR target display that can be set to the appropriate tone mapped output.
Enabling Simultaneous Monitoring

When you set up your display hardware, the HDR Master Display must be connected to output A, and the Target Display must be connected to output B of whichever BMD video output device you’re using. Then, you need to turn on the “Use dual outputs on SDI” checkbox in the Master Settings of the Project Settings. At this point, assuming all of your connections are compatible with one another, you should see an HDR image output to your HDR display and a trimmed image output to your SDR display.

Limitations

As of the time of this writing, there are some limitations to simultaneous HDR/SDR output from DaVinci Resolve.

– The resolution for both the Master and Target output is limited to 1080; choosing a higher resolution may cause problems.
– This workflow does not work for Stereo 3D projects.
– Each output is limited to Single Link (a single HD-SDI connection).
– Output can be either 444 or 422.

HDR10+ Auto Analysis Commands

After you’ve graded an HDR version of each clip in your program, a set of HDR10+ specific commands let you auto-analyze each clip to create custom HDR to SDR downconversion metadata that give you a starting point for the SDR trim pass you need to do. These commands are available in the Color > HDR10+ submenu:

– Analyze All Shots: Automatically analyzes each clip in the Timeline and stores the results individually.
– Analyze Selected Shot(s): Only analyzes selected shots in the Timeline.
– Analyze Selected and Blend: Analyzed multiple selected shots and averages the result, which is saved to each clip. Useful to save time when analyzing multiple clips that have identical content.
– Analyze Current Frame: A fast way to analyze clips where a single frame is representative of the entire shot.

HDR10+ Palette

An HDR10+ trim palette is visible to all Resolve Studio users, which shows the auto-analyzed trim metadata. At the time of this writing, these sliders are disabled for manual adjustment.
The Enable Tone Mapping Preview checkbox lets you turn the tone mapping trim being applied off and on, so you can evaluate how the downconverted SDR version looks on your HDR display. This control is disabled when you enable “Use dual-outputs on SDI” in the Master Settings of the Project Settings, since the second output SDI now automatically displays the target display output.

**Delivering HDR10+**

Once you’re finished grading the HDR and trimming the SDR downconversion, you need to output your program correctly in the Deliver page.

**Rendering an HDR10+ Master**

To deliver an HDR10+ master after you’ve finished grading, you want to make sure that the Output Color Space of the Color Management panel of the Project Settings is set to the appropriate HDR ST.2084 setting based on the peak output you want to deliver (any values above will be clipped). Then, you want to set your render up to use the highest quality Format/Codec combination that can be delivered to whomever is doing the final mastering.

The HDR10+ analysis and manual trim metadata you generated while trimming is saved per clip, in a series of JSON sidecar files, which should then be exported by right-clicking that timeline in the Media Pool, and choosing Timelines > Export > HDR10+JSON.

These two sets of files are then delivered to a facility that’s capable of creating an HDR10+ Mezzanine File (this cannot be done in DaVinci Resolve).

**NOTE:** The HDR10+ mastering workflow is still a work in progress. More information will be provided as it becomes available.

**Hybrid Log-Gamma (HLG)**

The BBC and NHK jointly developed another method of encoding HDR video, referred to as Hybrid Log-Gamma (HLG). The goal of HLG was to develop a method of mastering HDR video that would support a range of displays of different peak luminance capabilities without additional metadata, that could be broadcast via a single stream of data, that would fit into a 10-bit signal, and that in the words of the ITU-R Draft Recommendation BT.HDR, “offers a degree of compatibility with legacy displays by more closely matching the previous established television transfer curves.”

The basic idea is that the HLG EOTF functions very similarly to BT.1886 from 0 to 0.6 of the signal (with a typical 0–1 range), while 0.6 to 1.0 smoothly segues into logarithmic encoding for the highlights. This means that, if you just send an HDR Hybrid Log-Gamma signal to an SDR display, you’d be able to see much of the image identically to the way it would appear on an HDR display, and the highlights would be compressed to present an acceptable amount of detail for SDR broadcast.

On a Hybrid Log-Gamma compatible HDR display, however, the log-like highlights of the image (not the BT.1886-like bottom portion of the signal, just the highlights) would be stretched back out, relative to whatever peak luminance level a given HDR television is capable of outputting, to return the image to its true HDR glory. This is different from the HDR10 method of distribution described previously, in which the graded signal is referenced to absolute luminance levels dictated by ST.2084, and levels that cannot be represented by a given display will be clipped.

And while this facility to support multiple HDR displays with differing peak luminance levels is somewhat analogous to Dolby Vision’s ability to tailor HDR output to the unique peak luminance levels of any given Dolby Vision-compatible television, HLG requires no additional metadata to guide how the highlights are scaled, which depending on your point of view is either a benefit (less work), or a deficiency (no artistic guidance to make sure the highlights are being scaled in the best possible way).
As is true for most things, you don’t get something for nothing. The BBC White Paper WHP 309 states that, for a 2000 cd/m² HDR display with a black level of 0.01 cd/m², up to 17.6 stops of dynamic range without visible quantization artifacts (“banding”) is possible. BBC White Paper WHP 286 states that the proposed HLG EOTF should support displays up to about 5000 nits. So, partially, the backward compatibility that HLG makes possible is due in part to discarding long-term support for 10,000 nit displays. However, it’s an open question whether or not over 5000 nits is even necessary for consumer enjoyment.

Sony, LG, Panasonic, JVC, Phillips, Hisense, Hitachi, and Toshiba have all either announced or are shipping consumer HDR televisions capable of displaying HLG encoded video, and of course DaVinci Resolve supports this standard through Resolve Color Management.

Grading Hybrid Log-Gamma in DaVinci Resolve

Monitoring an ST.2084 image is as simple as getting a Hybrid Log-Gamma-compatible HDR display, and connecting the output of your video interface to the input of the display.

Setting up Resolve Color Management to grade for HLG is identical to setting up to grade for Dolby Vision, except that there are four HLG settings to choose from for the Output Color Space:

- Rec.709 HLG ARIB STD-B67
- Rec.2020 HLG ARIB STD-B67
- Rec.2100 HLG
- Rec.2100 HLG (Scene)

Optionally, if you choose to enable “Use Separate Color Space and Gamma,” you can choose either Rec. 2020 or Rec. 709 as your gamut, and Rec. 2100 HLG as your EOTF.

The levels you’ll be monitoring in your scopes will be different from the table of data to nit values listed previously for grading to the PQ EOTF.

Outputting Hybrid Log-Gamma

Once you’ve created an HLG grade for your program, you can output it to any high-quality 10-bit capable media format.
DaVinci Resolve is a resolution-independent application. This means that, whatever the resolution of your source media, it can be output at whatever other resolution you like, and just about every size-dependent effect in your project, text, windows of grades, edit and input clip scaling, and other effects will scale appropriately to match the new output resolution.

This also means that you can freely mix clips of any resolution, fitting 4K, HD, and SD clips into the same timeline, with each scaling to fit the project resolution as necessary.

Your project’s resolution can be changed at any time, allowing you to work at one resolution, and then output at another resolution. This also makes it easy to output multiple versions of a program at different resolutions, for example, outputting 4K, HD, and SD sized versions of the same timeline.

Additionally, most controls that let you transform clips, either to push into a clip for creative intent, or to pan and scan media of one format to fit better into a different output format, are smart enough to always refer back to the source resolution when combining resizing operations to shrink, then enlarge an image for various reasons as you work in the Cut, Edit, Fusion, and Color pages.

This chapter covers the relationship among the different sizing and transform controls found in DaVinci Resolve, showing how they work together to intelligently manage the sizing of clips and effects as you work.
About Resolution Independence

If you only read one paragraph of this chapter, read this: Resolution Independence in DaVinci Resolve means you can add clips to a timeline in any combination of resolutions to fit the project resolution you’ve chosen to work at, and you can later output that timeline to as many other resolutions as necessary in order to create multiple deliverables. When you do so, all effects and transforms will automatically readjust themselves to match the sizing of each new timeline resolution, and most transforms are calculated and processed using the full native resolution of the source media you’ve linked to that clip.

In short, what this means is that you can create multiple deliverables in multiple resolutions by simply changing the timeline resolution or by using a lower resolution setting in the Deliver page compared to the timeline resolution when you create a new job to render out, and every effect will be the right size automatically.
Timeline Resolution

The timeline resolution is one of the most fundamental settings of your project, defining its frame size. It's found in the Master Settings panel of the Project Settings, where you can choose a predefined resolution from the "Timeline resolution" drop-down menu, or you can type a custom resolution into the X and Y fields below.

Mixing Clip Resolutions

Media used in a project does not have to match the timeline resolution. In fact, it's extremely common to mix multiple resolutions within the same timeline. Clips that don't match the current resolution will be automatically resized according to the currently selected Image Scaling setting (described below).

Changing the Timeline Resolution

As mentioned earlier, you can change the timeline resolution whenever you like. When you do so, each Edit page transform, Fusion clip effects output, Color page Power Window, Input and Output Sizing adjustment, tracking path, spatial keyframing value, as well as any other other resolution-dependent Resolve FX effect or transform operation in DaVinci Resolve is automatically and accurately scaled to fit the new resolution.

You Can Use Separate Timelines to Output Different Resolutions

Beginning in DaVinci Resolve 16, you have the option of creating separate timelines with individual Format (including Input Scaling), Monitoring, and Output Sizing settings for situations where you need to set up multiple timelines to create multiple deliverables with different resolutions, pixel aspect ratios, frame rates, monitoring options, or output scaling options than the overall project, including "Mismatched Resolution Files" settings. For more information, see Chapter 35, "Creating and Working with Timelines."

You Don’t Need Separate Timelines to Output Different Resolutions

Because of the way DaVinci Resolve works, it’s not necessary to create separate timelines when all you need is to output the same timeline at multiple resolutions. Instead, you can focus on mastering a single timeline, which you can output to as many other resolutions as you need.

For example, with only a single timeline in a project set to 4096x2160 (4K DCI) resolution, you can easily output UHD, HD, center-cut SD, and center-cut Instagram sized deliverables in any format you need by simply changing the Resolution drop-down setting in the Deliver page Render Settings before you create a job to render. DaVinci Resolve takes care of the rest.
The Deliver page drop-down menu in the Render Settings panel lets you choose what resolution you want to output the current timeline using

Using High Resolution Media in Lower Resolution Projects

Every set of transform and sizing parameters and settings that resize clips is combined intelligently, so that the full resolution of a clip’s source media is always used as the source for any transform. For example, if you’re using 8K media within a 1920x1080 project, and you need to enlarge a clip using the Input Sizing palette’s Zoom parameter to 200%, the image is scaled relative to the native 8K resolution of the source, and the result is fit into the current timeline resolution. This automatically guarantees the highest quality for any image transform you make so long as you don’t zoom in past the native resolution of any given clip.

This also applies to situations where, for example, you shrink a clip in the Edit page using the Edit Sizing controls, only to re-enlarge the same clip in the Color page, using the Input Sizing controls. In this situation, DaVinci Resolve is smart enough to do the math combining the project resolution, the Edit Sizing, and the Input Sizing controls so that a single transform is applied to the native source resolution of that clip, giving you the best quality result.

**NOTE:** This changes when you apply Fusion effects to any clip, as described later in this chapter.

Clip Source Resolution

Clip resolution in DaVinci Resolve is handled by the combination of Pixel Aspect Ratio and Resolution.

**Pixel Aspect Ratio (PAR)**

The Timeline Format settings, found in the Master Settings of the Project Settings, let you specify a Pixel Aspect Ratio for the project, in addition to the frame size. This setting defaults to Square Pixel, which is appropriate for high definition projects and most digital media. However, there are also options for 16:9 anamorphic, 4:3 standard definition, or Cinemascope. Which options are available depends on what timeline resolution you’ve selected.

In addition, each clip has individually adjustable PAR settings in the clip attributes, for situations where you’re mixing multiple types of media within a single project. For example, if you’re mixing SD clips with non-square pixels and HD clips with square pixels, you can sort out all of the SD clips in the Media Pool and assign them the appropriate NTSC or PAL non-square pixel ratio PAR setting. For more information, see Chapter 21, “Modifying Clips and Clip Attributes.”
Clip Resolution

Ordinarily, the resolution of a clip is entirely dependent on the resolution that was selected when that media was shot, or rendered out of a compositing, VFX, or 3D application. Once a piece of media has been created, the native resolution of that media cannot be changed, and to maintain the ideal amount of sharpness for that clip, you need to make sure that whatever transforms you apply to resize a clip zoom into that clip no more than 10-20% over its native resolution (if even that), otherwise the image will visibly soften.

However, DaVinci Resolve provides advanced Super Scale image processing in the Clip Attributes of every video and image clip, that make it possible to resize clips beyond their native resolution while maintaining the perceptible sharpness of a clip that’s still within it’s native resolution. This is an illusion, but it’s a convincing one.

The DaVinci Resolve Sizing Pipeline

This section discusses the various sizing controls that are available in DaVinci Resolve, and how they work together.

“Super Scale” High Quality Upscaling (Studio Version Only)

For instances when you need higher-quality upscaling than the standard Resize Filters allow, you can now enable one of three “Super Scale” options in the Video panel of the Clip Attributes window for one or more selected clips. Unlike using one of the numerous scaling options in the Edit, Fusion, or Color pages, Super Scale actually increases the source resolution of the clip being processed, which means that clip will have more pixels than it did before and will be more processor-intensive to work with than before, unless you optimize the clip (which bakes in the Super Scale effect into the optimized media) or cache the clip in some way.

Super Scale options in the Video panel of the Clip Attributes

The Super Scale drop-down menu provides three options of 2x, 3x, and 4x, as well as Sharpness and Noise Reduction options to tune the quality of the scaled result. Note that all of the Super Scale parameters are in fixed increments; you cannot apply Super Scale in variable amounts. Selecting one of these options enables DaVinci Resolve to use advanced algorithms to improve the appearance of image detail when enlarging clips by a significant amount, such as when editing SD archival media into a UHD timeline, or when you find it necessary to enlarge a clip past its native resolution in order to create a closeup.

You may find that, depending on the source media you’re working with, setting Sharpness to Medium yields a relatively subtle result that can be hard to notice, but setting Sharpness to high should be immediately more preferable, while also sharpening grain and noise in the image to an undesirable extent at the default settings. However, while raising Noise Reduction will ameliorate this effect, it will also diminish the gains you obtained by raising Sharpness. In these cases, it’s worth experimenting with keeping Sharpness at Low or Medium so that Super Scale sharpens all aspects of a clip, but then using the Noise Reduction tools of the Color page (with their additional ability to be fine-tuned) to diminish the unwanted noise.
**TIP:** Super Scale, while incredibly useful, is a processor-intensive operation, so be aware that turning this on will likely prevent real-time playback. One way to get around this is to create Optimized Media for clips in which you’ve enabled Super Scale, since Optimized Media “bakes in” the Super Scale effect. Another way to work is to create a string-out of all of the source media you’ll need to enlarge at high-quality, turn on Super Scale for all of them, and then render that timeline as individual clips, while turning on the “Render at source resolution” and “Filename uses > Source Name” options.

### Fusion Effects and Resolution

All image processing by the Fusion page takes place before effects that are applied by the Edit page, with the sole exception of the Lens Correction effect. When it comes to sizing and image resolution, whether or not the Fusion page affects resolution depends on how you use it.

**Fusion Effects Inherit the Source Resolution of a Clip**

When you open a clip on the Timeline in the Fusion page, the Fusion page is set to the full source resolution of that clip, regardless of the Timeline resolution. This can be seen if you look at the resolution that’s listed above the upper right-hand corner of the Viewer. This means that if you don’t apply any operations that reduces the image resolution (described later), subsequent sizing adjustments in other pages will refer to the same resolution as the source clip.

**Fusion Clips Inherit the Timeline Resolution**

If you combine multiple clips on the Timeline into a Fusion clip, the Fusion page is set to the timeline resolution, regardless of the source resolution of the clip. The image is then output to the Edit page at this timeline resolution, and all subsequent sizing adjustments are performed relative to the timeline resolution, with no reference to the original resolution in the source clip.
The available resolution and bit depth of a clip that’s been turned into a Fusion Clip, that’s set to the timeline resolution of 1920x1080

Operations in the Fusion Page That Change Resolution
If you don’t do anything to change the size of a clip in the Fusion page, then its resolution stays the same and you’ll effectively output the source resolution of that clip to the Edit page.

However, if you Merge the image with a second clip attached to the background which has a different resolution, or if you use a Crop or Resize node to increase or decrease the resolution of the image, then the new resolution will be passed to the Cut and Edit pages as the effective source resolution of that clip.

In short, the Fusion page passes whatever resolution is output by the last node of your composition back to the Edit page as the effective resolution of that clip in the DaVinci Resolve image processing pipeline.

Fusion Page Transform Operations Are Resolution Independent
Within the Fusion page, multiple Transform nodes operate in a resolution independent manner relative to the resolution of the source clip. This means that if you shrink an image to 20% with one Transform node, and then enlarge it back up to 100% using a second Transform node, you end up with an image that has all the resolution and sharpness of the input image.

Fusion Page Resize Operations Are Not
Within Fusion there are two kinds of transform effects, the Transform node and the Resize node. Which of these nodes you use has a dramatic impact on resolution independence.

- The Transform node always refers back to the input resolution of the clip (as defined by the Clip Attributes) to enable resolution-independent sizing, such that multiple Transform nodes can scale the image down and up repeatedly within the Fusion page with no unnecessary loss of image resolution.

- The Resize node actually decreases image resolution when you shrink an image or increases image resolution (with filtering) when enlarging. This means that the Resize node will break resolution independence, and the resolution of the image will be fixed at whatever you specify from that point in your composite’s node tree forward.
In most situations, you probably want to use the Transform node to maintain resolution independence relative to the source media, unless you specifically want to alter and perhaps reduce image resolution to create a specific special effect which purposefully degrades the image. For example, if you want a clip to be forced to a standard definition resolution in order to make it look like a low-resolution archival clip, the Resize node will accomplish this. Enlarging the result with a Transform node will then perform a filtered enlargement that will look like a real SD clip being enlarged.

**Transforms from the Fusion Page to the Edit Page**

All transform operations you apply on the Cut, Edit, and Color pages are resolution independent, referring to the original resolution of the source media, so long as you don’t use the Fusion page. For example, if you shrink an image to 20% in the Edit page (using Edit sizing controls) and then enlarge it in the Color page back to 100% (using Input sizing controls), you end up with an image that has all the resolution and sharpness of the original media, because the final resolution is drawn from the original source media.

However, once you use the Fusion page to do anything to a clip, from adding a small effect to creating a complex composition, the resolution-independent relationship of the Edit and Color pages to the source media is broken, and whatever resolution is output from your Fusion composition is the new effective resolution of the clip that appears in the Timeline. This means if you shrink an image to 20% in the Fusion page (using a Transform node) and then enlarge it in the Color page by 150%, you end up with an image that isn’t as sharp as the original because the downconverted image in the Fusion page is effectively the new source resolution of that clip.

**Image Scaling**

DaVinci Resolve has a dedicated mechanism for automatically managing the size of clips with resolutions that don’t match the timeline resolution, and it’s separate from the Zoom transform controls that are available for making creative adjustments to clips. This is called Image Scaling, and it’s customizable in a few different areas.

**Resize Filter Project Setting**

The Resize Filter setting lets you choose the filter method that’s used to interpolate image pixels when resizing clips:

- **Smotherer**: May provide a more pleasing result for projects using clips that must be scaled down to standard definition as this filter exhibits fewer sharp edges at SD resolutions.
- **Bicubic**: While the sharper and smoother options are slightly higher quality, bicubic is still an exceptionally good resizing filter and is less processor-intensive than either of those options.
- **Bilinear**: A lower quality setting that is less processor-intensive. Useful for previewing your work on a low-performance computer before rendering when you can switch to one of the higher quality options.
- **Sharper**: Usually provides the best quality for most projects, using an optical quality processing technique that’s unique to DaVinci Resolve.
- **Custom**: This setting lets you take control of the exact algorithm used in all resizing operations. The custom Resize Filter options available are: Bessel, Box, Catmul-Rom, Cubic, Gaussian, Lanczos, Mitchell, Nearest Neighbor, Quadratic, and Sinc. In practice, the difference between these methods can be quite subjective. However, if you need to match a specific resizing method used from another application, you can do it here. For everyday use, the normal resizing filters in DaVinci Resolve should be sufficient.
- **Override Input scaling**: Checking this box lets you choose an Input Sizing preset to apply to the project.
- **Override Output scaling**: Checking this box lets you choose an Output Sizing preset to apply to the project.
– **Anti-alias edges**: A second group of settings lets you choose how to handle edge anti-aliasing for source blanking.

  – **Auto**: Adds anti-aliasing when any of the Sizing controls are used to transform the image. Otherwise, anti-aliasing is disabled.
  
  – **On**: Forces anti-aliasing on at all times.
  
  – **Off**: Disables anti-aliasing. It might be necessary to turn anti-aliasing off if you notice black blurring at the edges of blanking being applied to an image.

– **Deinterlace quality**: (only available in Studio version) A fourth group of settings lets you choose the quality/processing time tradeoff when deinterlacing Media Pool clips using the Enable Deinterlacing checkbox in the Clip Attributes window. There are two settings:

  – **Normal**: A high-quality deinterlacing method that is suitable for most clips. For many clips, Normal is indistinguishable from High. Normal is always used automatically during playback in DaVinci Resolve.
  
  – **High**: A more processor-intensive method that can sometimes yield better results, depending on the footage, at the expense of slower rendering times.
  
  – **DaVinci Neural Engine**: This option uses the advanced machine learning algorithms of the DaVinci Neural Engine to analyze motion between the fields of interlaced material and reconstructs them into a single frame. This option is very computationally intensive, but ideally will deliver an even more aesthetically pleasing result than the “high” setting.

### Input Scaling Project Setting

If the native resolution of an imported clip doesn’t match the timeline resolution, then the currently selected Input Scaling Preset in the Image Scaling panel of the Project Settings dictates how mismatched clips will be handled project-wide. The default setting is “Scale entire image to fit,” which shrinks or enlarges the image to fit the current dimensions of the frame without cropping any part of the image, adding letterboxing or pillarboxing as necessary to fill the unused portion of the frame depending on whether the horizontal or vertical dimension of the image hits the edge of the frame first.

The Mismatched resolution files option let you choose how clips that don’t match the current project resolution are handled. The illustrated examples below show an SD clip being fit into an HD project using each of the different options.

– **Center crop with no resizing**: Clips of differing resolution are not scaled at all. Clips that are smaller than the current frame size are surrounded by blanking, and clips that are larger than the current frame size are cropped. Keep in mind that this is a good setting to use if you’re importing a timeline from another NLE in which clip resolution adjustments are imported as scaling adjustments. Choosing “Center Crop with no resizing” prevents DaVinci Resolve from “double scaling” clips in imported timelines.
– **Scale full frame with crop:** Clips of differing resolution are scaled so that the clip fills the frame with no blanking. Excess pixels are cropped. This is a good setting when you want clips that don’t match the project resolution to automatically fill the frame, with no letterboxing or pillarboxing.

![Source and Target Images](image1.png)

– **Scale entire image to fit:** The default setting. Clips of differing resolution are scaled so that each clip fills the frame without cropping. The dimension that falls short has blanking inserted (letterboxing or pillarboxing). This is a good setting when you want clips that don’t match the project resolution to automatically fit into the frame without being cropped in any way, and you’re fine with letterboxing or pillarboxing as a result. However, if you’ve imported a timeline from another NLE and there are clips that are twice as big as they should be, it’s because this setting is on by default, and your imported timeline has imported scaling settings used to resize clips that didn’t match the timeline resolution. If this happens, switch to “Center crop with no resizing” instead, and that will fix the problem.

![Source and Target Images](image2.png)

– **Stretch frame to all corners:** Useful for projects using anamorphic media. Clips of differing resolutions are squished or stretched to match the frame size in all dimensions. This way, anamorphic media can be stretched to match full raster or full raster media can be squished to fit into an anamorphic frame. An added benefit of this setting is that it makes it easy to mix anamorphic and non-anamorphic clips in the same project.

![Source and Target Images](image3.png)

**Output Image Scaling Project Settings**

Another group of settings found in the Image Scaling panel of the Project Settings lets you optionally choose a different resolution to be output, either via the Deliver page, or via your video output interface for monitoring or outputting to tape.
In particular, if you set the “Resolution” in the Render Settings panel of the Deliver page to something other than the timeline resolution, these settings are used to make the change. This is useful in situations where you're mastering a high resolution 4K project, but you want to monitor using an HD display, and you plan on eventually outputting HD resolution deliverables in addition to the 4K deliverables for which you want to use different Scaling and/or Resize Filter settings that work better at the lower resolution.

- **Match timeline settings**: This checkbox is turned on by default so that these settings mirror the Image Scaling and Input Scaling settings described above. Turning this checkbox off lets you choose different settings to be used when monitoring, outputting to tape, or rendering, using the other settings below.

- **Output resolution**: Lets you choose an alternate resolution for monitoring and delivery. You can also set this from the “Resolution” drop-down menu of the Video panel in the Render Settings of the Deliver page.

- **For “X x Y” processing**: Lets you specify a different custom alternate resolution.

- **Pixel aspect ratio**: Lets you specify an alternate pixel aspect ratio to match the alternate timeline format.

- **Mismatched resolution files**: Lets you choose an alternate way of handling mismatched resolution files that works better for the alternate resolution you’ve chosen. These options work similarly to those of the “Input Scaling” group. For example, for an HD or UHD resolution project you may have the Image Input Scaling set to “Scale Full Frame With Crop” so that all Standard Definition resolution files are center-cut to eliminate blanking. However, if you’re using Output Image Scaling to create a Standard Definition deliverable, you may want to set the Output Image Scaling > Mismatched resolution files setting to “Scale entire image to fit” in order to letterbox all HD or UHD resolution clips, while preserving the original aspect ratio of the SD clips.

- **Super Scale**: Sets a very processor-intensive and high quality upscaling algorithm that actually creates new pixels for the resized image. The possible values are None, 2x, 3x, 4x, and Auto.

**Clip-Specific Scaling Settings**

There’s an additional set of Scaling and Resize Filter settings, available in the Video Inspector for selected clips, that provide the same options as those found in the Project Settings window, except that they let you choose settings that will be specific to a particular clip. These are valuable for situations where the project-wide scaling setting is working for most clips, but you have a handful of specific clips that would benefit from individual settings.

**Edit Sizing in the Cut and Edit pages**

The Video Inspector contains a set of Transform parameters with which you can alter clips in the Timeline. These parameters operate independently of the Input Sizing controls found in the Color page. Separate Edit sizing controls serve a number of different functions:

- They’re convenient for editors and are easily animated for creating motion graphics effects right on the Cut and Edit page timelines. They also keep editor transform adjustments separate from colorist transform adjustments, for a clear division of labor and responsibility.

- Edit sizing parameters also store incoming transform data from imported AAF and XML projects that come from other applications, so that imported transforms are kept separate from adjustments made by colorists and finishing artists.
If, when importing an AAF or XML project file, you turned on the “Use sizing information” checkbox, then every clip that had position, scale, rotation, or crop settings applied in the originating NLE will have those adjustments applied to these transform parameters, which is convenient for keeping imported transform settings separate from other DaVinci Resolve-native transform settings.

Additionally, a set of Dynamic Zoom parameters also exists in the Video Inspector, which let you make quickly animated transforms using graphical controls that correspond to the start and end states of an animated transform. However, these transforms are lumped in with the other Edit page Transform parameters in terms of the order of sizing operations occurring throughout DaVinci Resolve.

The Dynamic Zoom settings in the Inspector of the Video Inspector

The transform that’s made via the Edit Sizing controls refers back to either the source resolution of each clip, or the resolution output by the Fusion page if it’s in use.

**Image Stabilization**

DaVinci Resolve provides Image Stabilization controls in the Cut, Edit, and Color pages that all control the same transform operation that happens between Edit sizing and Input Sizing in the image processing pipeline. The transform that’s made via the Image Stabilization controls refers all the way back to either the source resolution of each clip, or the resolution output by the Fusion page if it’s in use.

**Input Sizing on the Color Page**

The Sizing palette on the Color page has another dedicated set of keyframable transform parameters that work with the various DaVinci control panels to let the colorist apply pan and scan adjustments while working through a project. These parameters work independently of the Edit page Transform parameters, allowing you to keep imported transform settings separate from other transform settings that you apply. However, for convenience the Edit sizing controls are available in the Color page as well.

The transform that’s made via the Input Sizing controls refers all the way back to either the source resolution of each clip, or the resolution output by the Fusion page if it’s in use.
Node Sizing on the Color Page

Using Node Sizing, you can apply individual sizing adjustments to clips on a per-node basis within the Color page, which is similar in principal to using Transform nodes in the Fusion page. All Node Sizing adjustments within a grade are cumulative, and any keyframing done to Node Sizing parameters is stored in that node’s Node Format keyframe track in the Keyframe Editor. Two good examples of Node Sizing include realigning color channels individually in conjunction with the Splitter/Combiner nodes or duplicating windowed regions of an image by moving them around the frame. Subsequent Node Sizing operations do not refer back to the source resolution of a clip, so using multiple Node Sizing operations to reduce and enlarge an image will reduce image resolution and sharpness.

Output Sizing on the Color Page

Output sizing is an additional transform that is applied after Edit sizing, Fusion sizing, Input sizing, and Node sizing. It’s an overall adjustment that affects every clip at once, which is suitable for making last-minute format alterations that you want to affect the entire program. Technically, Output Sizing includes the Blanking controls, but those are important enough to discuss separately. Output Sizing also does not refer back to the source resolution of clips, so if you use Edit or Input Sizing to shrink a clip, and Output Sizing to enlarge it again, the final result will be somewhat softened as you’re enlarging the lower resolution image output by Input Sizing.

Output Blanking

Output blanking is not a sizing operation, but it’s often related and so worth mentioning here. Blanking is an adjustment you can use to add black areas to the top, bottom, left, or right of an image, in order to add “letterboxing” (black bars at the top and bottom of the image) or “pillarboxing” (black bars at the left and right of the image) that lets you fill in the unused parts of an image frame that’s either shorter or thinner than the current output resolution.

Once all transforms, compositing operations, and color corrections have been applied by the DaVinci Resolve image processing pipeline, the very last operation to be performed is Output blanking, if it’s enabled. This guarantees that overlapping images, grading, and other adjustments are properly “blacked out” no matter what you’re doing to the program.

Output Blanking controls are found in the Timeline menu (as a series of aspect ratios) as well as in the Output Sizing parameters of the Color page Sizing palette (via Top, Right, Bottom, and Left controls).

Tip: Text and graphics superimposed via the Data Burn-In window, if enabled, are the only effects that will appear in front of picture areas affected by blanking. This lets you add timecode and other information over letterboxed areas that you don’t want to obscure the picture.

Format Resolution on the Delivery Page

By default, the Format Resolution setting in the Render Settings of the Deliver page matches the timeline resolution when “Match timeline settings” is enabled in the Output Scaling Preset in the Image Scaling panel of the Project Settings.

Choosing a new resolution from the “Set Resolution to” drop-down menu lets you override the current Format Resolution setting before rendering. Using this control, you can queue up multiple jobs, each set to a different resolution, to output multiple formats during a single render session.

For more information on rendering and setting up jobs for the Render Queue, see Chapter 185, “Using the Deliver Page.”
Rendering Sizing Adjustments and Blanking

When rendering your final output, you have the option of choosing whether or not to “bake in” the sizing operations that have been performed. For example, you may have set up a whole set of specific sizing adjustments for the clips in a program, but then you’re requested to render the project and its media as individual clips for round trip re-delivery to the editor for further work. In this case, you can choose to either render the sizing into the final media, or not.

Whether or not sizing is rendered into your final media depends on the “Disable edit and input sizing” checkbox in the Advanced Settings options of the Render Settings panel. You can disable sizing and blanking either when rendering the current timeline as a single clip, or when rendering individual clips.

– **If “Disable sizing and blanking output” is turned off:** Output Blanking, Cut and Edit page sizing adjustments, Color page Input and Output Sizing adjustments, and Image Stabilization are rendered into the final rendered media using the optical-quality sizing algorithms available to DaVinci Resolve. This is best if your sizing adjustments are approved and final, and you want to “bake” sizing adjustments into the final media you’re delivering.

– **If “Disable sizing and blanking output” is turned on:** Output Blanking, Cut and Edit page sizing adjustments, Color page Input and Output Sizing adjustments, and Image Stabilization are not rendered, and each clip will be rendered either at the source resolution if “Render at source resolution” is enabled in individual clips mode, or to the currently specified resolution of the timeline or project. However, the sizing adjustments you’ve made will be exported as part of the XML or AAF file that you’re exporting. This is best for workflows where the editor wants to continue adjusting sizing after you’ve handed off the graded project relative to the original size of the clips.

Keep in mind that if you want to render Input Sizing adjustments into the media you’re outputting, the “Force sizing to highest quality” checkbox guarantees that DaVinci Resolve will use the highest-quality sizing setting, even if you’ve temporarily chosen a faster-processing option for a slower computer.

**NOTE:** “Disable sizing and blanking output” does not disable any transform operations that happen within the Fusion page. Those will continue to be applied to the final output.
Chapter 11

Data Burn

This chapter covers how to use the Data Burn window that’s available to every page in DaVinci Resolve.

Contents

Data Burn 247
Project vs. Clip Mode 248
Setting Up Burned-In Metadata 248
Saving and Loading Burn-In Presets 248
Data Burn Metadata 249
Custom Output Options 250
Gang Rendered Text Styles 251
Prefix Render Text 251
Data Burn

The Data Burn window lets you display select metadata as a timeline-wide “window burn” that’s superimposed over the image in the Viewer. This window burn is written into files that you render in the Deliver page, and it’s also output to video, for viewing on your external display, or for outputting to tape.

The Data Burn window is available by choosing Workspace > Data Burn-In.

Traditionally, window burns are useful as a reference when creating offline media that you need to keep track of later. However, the Data Burn window is extremely flexible. For example, it’s also useful for watermarking review files that you don’t want to be distributed accidentally with either custom text or graphics with alpha channels, for adding graphical logos or “bugs” to programs in preparation for broadcast (again, optionally using graphics with alpha channels), for superimposing custom reference guidelines of some sort over the images being monitored, or even just for temporarily displaying timecode or clip names to refer to on your monitor while editing, mixing, or reviewing graded dailies with a client.
Project vs. Clip Mode

Two buttons at the top of the Data Burn window let you choose whether you want to edit one set of burned-in metadata that will be displayed for the entire duration of the Timeline, or edit burned-in metadata on a clip-by-clip basis. You can combine the two, having timeline-wide window burn settings and separate clip-specific window burn settings for a handful of clips in that timeline at the same time.

When rendering in the Delivery page, window burns are applied both when rendering timelines as individual source clips and when rendering as one single clip.

Setting Up Burned-In Metadata

Setting up different clip and project metadata to output as a window burn is easy.

To set up a window burn:
1. Choose Workspace > Data Burn-In.
2. Click Project or Clip at the top of the Data Burn-In window.
3. Turn on the checkboxes of whatever items of metadata you want to display in the “Add to Video Output” column. More information about the available items appears later in this chapter.

   The first item of metadata is centered near the bottom of the frame, above Action Safe. Each additional item of metadata you turn on for display is added above whichever items are already displayed, regardless of their position in the “Add to Video Output” list.

4. Click any currently enabled item of metadata from the list to highlight it in black, and edit that item’s Custom Output parameters at the right. More information about the available parameters appears later in this chapter.

To reset the current window burn setup:
Click the Reset button next to the Option drop-down menu to reset the current mode of the Data Burn window.

Saving and Loading Burn-In Presets

If there are common sets of metadata that you regularly use and switch among, you can save each setup as a preset for future use.

To save a burn-in preset:
1. Click the Option menu and choose Save As New Preset.
2. Type a name into the Burn In Preset dialog that appears, and click OK. That preset is added to the list of saved presets in the Option menu.
To delete a burn-in preset:
1. Choose a preset from the Option menu.
2. Click the Option menu, and choose Delete.
3. A dialogue box appears asking you to confirm the deletion.

To modify a burn-in preset:
1. Choose a preset from the Option menu.
2. Edit it however you like.
3. Click the Option menu, and choose Update.

Data Burn Metadata

The leftmost column in the Data Burn window contains a list of all the options that you can add to the video output as a window burn. Each option has a checkbox that lets you turn it on or off. You can also select in the Option drop-down if you would like the item name rendered as a prefix to the burn-in data.

- **Record Timecode**: The timecode relative to the Timeline, as set in the Conform Options section of the General Options panel of the Project Settings.
- **Record Frame Number**: The number of frames from the first frame of the Timeline.
- **Source Timecode**: Each clip's individual timecode.
- **Source Frame Number**: The number of frames from the first frame of the clip.
- **Record TC & Frame Num**: Both metadata options combined in one line.
- **Source TC & Frame Num**: Both metadata options combined in one line.
- **Source & Record TC**: Both metadata options combined in one line.
- **Feet + Frames 35mm**: Displays a Feet + Frames conversion of the program’s record timecode, calculated for 35mm film.
- **Feet + Frames 16mm**: Displays a Feet + Frames conversion of the program’s record timecode, calculated for 16mm film.
- **Audio Timecode**: The timecode of audio that’s been synced to a clip.
- **Keycode**: Also referred to as edge-code, the identification codes running along the edge of film stocks that provide an absolute reference for which digital frames correspond to which film frames.
- **Source File Name**: The full file path, including file name, of the media file that’s linked to the current clip.
- **Record File Name**: The file name as defined in the Render Settings list of the Deliver page.
- **Source Clip Name**: The file name of the media file that’s linked to the current clip, without the file path.

**NOTE**: If two clips overlap in the Timeline, the metadata that matches the currently visible clip in the Viewer is what will be displayed in the window burn.
– **Custom Text1**: A line of text that you type into the Text field of the Custom Output parameters. You can use any characters you like. When editing any of the three custom text fields that are available, you can use “metadata variables” that you can add as graphical tags that let you display clip metadata. For example, you could add the corresponding metadata variable tags `%scene_%shot_%take` and the custom text would display “12_A_3” if “scene 12,” “shot A,” “take 3” were its metadata. For more information on the use of variables, as well as a list of all variables that are available in DaVinci Resolve, see Chapter 15, “Using Variables and Keywords.”

– **Custom Text2**: A second line of text that you can customize.

– **Custom Text3**: A third line of text that you can customize.

– **Logo1**: Lets you superimpose a graphic over the image in a customizable location. Compatible graphics formats include PNG, TGA, TIF, BMP, and JPG. Alpha channels are supported for transparency in logos.

– **Logo2**: Lets you superimpose a second graphic.

– **Logo3**: Lets you superimpose a third graphic.

– **Reel Name**: The currently defined reel number for the current clip.

– **Shot**: Shot metadata, if it’s been written to the file by a camera, or entered into the Metadata Editor on the Media page.

– **Scene**: Scene metadata, if it’s been written to the file by a camera, or entered into the Metadata Editor on the Media page.

– **Take**: Take metadata, if it’s been written to the file by a camera, or entered into the Metadata Editor on the Media page.

– **Angle**: Angle metadata, if it’s been written to the file by a camera, or entered into the Metadata Editor on the Media page.

– **Day**: Day metadata, if it’s been written to the file by a camera, or entered into the Metadata Editor on the Media page.

– **Date**: Date metadata, if it’s been written to the file by a camera, or entered into the Metadata Editor on the Media page.

– **Good Take**: Corresponds to Good Take metadata, if it’s been written to the file by a camera, or entered into the Metadata Editor on the Media page.

– **Camera**: Corresponds to the Camera metadata, if it’s been written to the file by a camera, or entered into the Metadata Editor on the Media page.

– **Roll/Card**: Corresponds to the Roll/Card metadata, if it’s been written to the file by a camera, or entered into the Metadata Editor on the Media page.

### Custom Output Options

The parameters in the Custom Output panel let you modify the look, position, and in some cases content, of the selected metadata item. Pan and Tilt are individually customizable for each metadata item.

– **Display During First x frames**: Turning on this checkbox lets you specify a number of frames during which the current item of metadata will be displayed before dissolving away over one second. When enabled, the current item of metadata will cut onscreen with the beginning of each new clip, remain onscreen for the duration specified, and then dissolve away.

– **Display During Last x frames**: Turning on this checkbox lets you specify a number of frames before the end of each clip during which the current item of metadata will appear onscreen after fading up over one second, before cutting away with the end of the clip.
– **Font:** Defaults to Courier, but you can choose any font that’s installed on your system.

– **Size:** Defaults to 48, but you can choose standard increments from 6 to 72.

– **Alignment:** Defaults to Center. The only other option is Left.

– **Font (color):** Defaults to white, but you can choose from a range of predefined colors in this drop-down menu.

– **Background:** Defaults to black, although the apparent color is influenced by the Opacity setting. For a more garish look, you can choose from a range of predefined colors in this drop-down menu.

– **Text Opacity:** Defaults to 1.00. Lets you define the transparency of the burned-in metadata’s text.

– **Background Opacity:** Defaults to 1.00. Lets you define the transparency of the burned-in metadata’s background color.

– **X-Y Position:** Lets you change the horizontal and vertical orientation of the current item of metadata. The default horizontal value is the center of the frame, relative to the current project’s frame size. The first item of metadata is centered vertically near the bottom of the frame, above Action Safe. Each subsequent item of metadata you turn on is automatically placed above the previous item of metadata, regardless of its order in the “Add to Video Output” list.

– **Text:** (only if one of the Custom Text options is checked) A text field that lets you enter custom text to display as one of three possible custom text items.

– **Logo:** (only if one of the Logo options is checked) A field that displays the file path of any currently selected graphic that you’re displaying as one of the three possible Logo graphics. Compatible graphics formats include PNG, TGA, TIF, BMP, and JPG. Alpha channels are supported for transparency in logos.

– **Import File button:** (only if one of the Logo options is checked) Lets you choose a graphics file to use as a logo.

### Gang Rendered Text Styles

You have the option of independently styling each item of metadata, depending on whether the Gang Render Text Styles option is checked in the Data Burn window’s Option menu. When turned on, all text metadata share the same font, size, color, background, justification, and opacity. When turned off, each item of metadata can have individual settings.

### Prefix Render Text

Another option in the Data Burn window’s Option menu lets you turn the prefixes, or headers, on or off for all metadata that’s enabled to be burned in.
Chapter 12

Frame.io Integration

DaVinci Resolve has sophisticated integration with Frame.io, a video review and collaboration service designed specifically for the postproduction industry. This integration consists of the ability to render and upload directly to Frame.io, maintain sync between Frame.io comments and timeline markers, and import media from Frame.io directly into the Media Pool.

Contents

Enabling Frame.io Integration in Preferences 253
Deliver and Upload to Frame.io 253
Frame.io Comments Sync with Timeline Markers 254
Importing Media from Frame.io 256
Linking Media Pool Clips and Timelines with Frame.io Clips 257
Enabling Frame.io Integration in Preferences

An Internet Accounts panel in the System tab of the DaVinci Resolve Preferences lets you sign into your Frame.io account and specify a local cache location for media being synced with Frame.io. You’ll need to enter your login name and password to enable Frame.io integration, but once entered, DaVinci Resolve will sign in automatically when DaVinci Resolve opens.

The Internet Accounts panel of the System tab of the DaVinci Resolve Preferences window (login deliberately obscured)

The local cache location is used to store clips you import into a DaVinci Resolve project from the Frame.io volume in the Media Storage panel of the Media page.

Deliver and Upload to Frame.io

A Frame.io preset at the top of the Deliver page’s Render Settings panel lets you render and upload a program for review. All options in the Render Settings panel update to present suitable controls for this process.

Choosing the Frame.io preset
When you choose the Frame.io preset, the Location field turns into an Upload To field, and the Browse button lets you choose a project and folder path to which to upload the exported result.

Choosing a Frame.io account to deliver a program to

When you export to Frame.io, the available choices in the Resolution, Format, Video Codec, and Type pop-up menus are limited to those that are most suitable for Frame.io file sharing. Choose the desired export options, then click the Add to Render Queue button to add this job to the Render Queue as you would with any other export. When that job is rendered, it automatically proceeds to upload to Frame.io, and an upload percentage indicator appears in the job listing to show how far along this upload is. When it’s finished, the job displays the text “Upload completed.”

The job in the Render Queue shows you the percentage the file has uploaded so far

This upload is done in the background, so you can continue working on other things in DaVinci Resolve while the file uploads. If you want to see how long the upload will take on any other page, you can choose Workspace > Background Activity to see the Background Activity window.

Frame.io Comments Sync with Timeline Markers

When you render a timeline directly to Frame.io, that timeline is automatically linked to the movie that’s been uploaded to Frame.io, and all comments, “Likes,” and graphical annotations (drawings and arrows) from reviewers that are added online via the Frame.io interface are automatically synced to Frame.io markers on your timeline (so long as your computer has an active internet connection). Frame.io markers are distinct from all other markers and can be independently shown and hidden, or deleted. Drawings and arrows from Frame.io are converted into their equivalent DaVinci Resolve annotation graphics for visibility in DaVinci Resolve.
Comments and graphical annotations from Frame.io appear as markers with their corresponding overlays in your DaVinci Resolve Timeline.

**Working With Frame.io Markers**

Double-clicking any Frame.io marker in the Timeline opens a dialog that lets you send replies to comments that appear on Frame.io, enabling editors to respond directly to commenters.

![Frame.io Comment Dialog](image)

The editor talking to himself using the Frame.io comment dialog that appears when you open a Frame.io marker.

You can also place Frame.io markers on the Timeline to have them automatically sync back to Frame.io, giving you the ability to send your own comments back to commenters (be kind).

If you delete one or more Frame.io markers on the DaVinci Resolve timeline, those markers will also be deleted in Frame.io. This includes the Mark > Delete All Markers > Frame.io command. This is not undoable.
Frame.io Marker Navigation

You can specifically navigate only the markers created in Frame.io while in the comment dialog of a Frame.io marker, using the Previous Marker (Shift-UpArrow) and Next Marker (Shift-DownArrow) commands. This allows you to skip directly from comment to comment in Frame.io without having to either navigate all markers in-between, or double-click each Frame.io marker individually to respond. Frame.io interoperability is a Studio Only feature.

Importing Media from Frame.io

A Frame.io volume appears in the Media Storage panel of the Media page that lets you access the media available from your Frame.io account. Within this Frame.io volume, a top-level directory represents your account directory, and within that each project you’ve created in Frame.io appears as a sub-directory.

Any media files that can be accessed in Media Storage can be imported into the Media Pool via the usual methods. Once added to the Media Pool, that media file downloads in the background to the specified local cache location, but it’s immediately available via your internet link until the download is complete, so you can begin working immediately. If you want to see how long the download will take, you can choose Workspace > Background Activity to see the Background Activity window.
Linking Media Pool Clips and Timelines with Frame.io Clips

You can also use Frame.io accessibility in the Media Storage panel of the Media page to link clips or timelines with media that’s already uploaded to your Frame.io account. Just locate and select a Frame.io clip in Media Storage, then right-click the clip or timeline you want to link it to in the Media Pool and choose Link to Frame.io Media from the contextual menu.

If you’ve linked a Frame.io clip to a timeline, comments made on that Frame.io clip appear on the linked timeline as Frame.io markers, just as if you’d exported that timeline directly to Frame.io.
The Color page has another mode available to aid you in using DaVinci Resolve in on-set grading workflows. Turning the Resolve Live option on puts DaVinci Resolve into a live grading mode, in which an incoming video signal from a camera can be monitored and graded during a shoot.

Contents

More About Resolve Live 259
Configuring Your System for Resolve Live 259
Grading Live 260
Getting Started 260
Going Live 260
Using Freeze 261
Using Snapshot 261
Using Resolve Live Grades Later 262
Using LUTs in Resolve Live Workflows 262
More About Resolve Live

Resolve Live has been designed to let you use all of the features of DaVinci Resolve to grade these on-set video previews, in the process saving video snapshots that contain a captured image, your grade, and reference timecode from the camera. The idea is that, using Resolve Live, you can work with the cinematographer to develop looks and test lighting schemes on the footage being captured during the shoot, and then later you can use those looks to build dailies, and as a starting point for the final grade once the edit has been completed.

Additionally, you can use Resolve Live in conjunction with other Color page features such as the Alpha output to build test composites to check green screen shots, comparing them against imported background images in order to aid camera positioning and lighting adjustments. The built-in video scopes can also be used to monitor the signal levels of incoming video. Finally, you can use 1D and 3D LUTs to monitor and grade log-encoded media coming off the camera.

Configuring Your System for Resolve Live

Setting up Resolve Live is straightforward. Whether you’re using a tower workstation or a laptop, any of the Blackmagic Design DeckLink or UltraStudio video interfaces can be used to connect your DaVinci Resolve workstation to a camera and external video display. The important thing to keep in mind is that, if you want to connect to a live incoming signal and output that signal for monitoring at the same time, you need to either use two separate DeckLink PCIe cards or UltraStudio Thunderbolt interfaces, or a single DeckLink Duo or DeckLink Studio card with multiple separate inputs and outputs on a single PCIe card.

The Video and Audio I/O panel of the System Preferences provides two sets of options for configuring video interfaces connected to your computer, one for playback, and one for capture. Resolve Live uses the capture input.

During the shoot, the digital cinema camera in use needs to be connected to your DaVinci Resolve workstation via HD-SDI, which must be configured to carry both the video image and timecode that mirrors the timecode being written to each recorded clip. Most cameras allow timecode output over HD-SDI, and both DeckLink and UltraStudio interfaces can pass this timecode to DaVinci Resolve. Without a proper timecode reference, you won’t be able to take the shortcut of automatically syncing your saved Snapshots to recorded camera original media using ColorTrace, although you can always apply grades manually.
Grading Live

Once your camera and computer are appropriately connected and configured, using Resolve Live is straightforward. This section describes the live grading workflow as it was designed to be used. Once you’re familiar with the capabilities of Resolve Live, you may find your own ways of working that are more in tune to the needs of your particular project.

Getting Started

When working with Resolve Live on a new shoot, you should begin with an empty project and a new empty timeline, since the live grading workflow involves capturing live graded snapshots to an otherwise unoccupied timeline. One recommended way of organizing the live grades of a shoot is to create one new project per day of shooting. This way, snapshots captured during shoots using all 24 hours of time-of-day timecode won’t conflict with one another. Also, separate projects can make it easier to use ColorTrace to copy grades from your live grade snapshots to the camera original media you’ll be creating dailies from, eventually.

**TIP:** Having an empty Media Pool and timeline doesn’t mean you can’t install useful LUTs and pre-import reference stills and saved grades to the Gallery, as these can be valuable tools for expediting your on-set grading.

Once you’ve created your new project, you also need to choose the disk where all snapshots you take will be saved. By default, snapshots are saved on the scratch disk at the top of the Scratch Disks list in the Media Storage panel of the System Preferences. They’re automatically saved in a folder named identically to the current project.

Going Live

Once you’ve created your day’s project, you need to turn on Resolve Live to begin work.

**To turn on Resolve Live:**

1. Open the Color page.
2. Choose Color > Resolve Live (Command-R).

A red Resolve Live badge at the top of the Viewer indicates that Resolve Live is turned on, and the transport controls are replaced by the Freeze and Snapshot buttons.
At this point, the video from the connected camera should become visible within the Viewer, the camera timecode should be displayed in the Viewer’s timecode window, and you can begin using all of the capabilities of the Color page to begin grading whatever is onscreen, including Gallery split-screens for matching and comparing. The current color adjustments in all palettes are automatically applied to both the image in the Viewer and the video output to an external display (if there is one).

While Resolve Live is on, much of DaVinci Resolve’s non-grading functionality is disabled, so when you’re finished, be sure to turn Resolve Live off.

**To turn off Resolve Live, do one of the following:**
- Click the Exit button at the bottom left-hand corner of the Viewer.
- Choose Color > Resolve Live (Command-R).

### Using Freeze

In Resolve Live mode, the Freeze button (it looks like a snowflake) freezes the current incoming video frame, so you can grade it without being distracted by motion occurring during the shoot. When you’ve made the adjustment you need, you can unfreeze playback in preparation for grabbing a snapshot.

**To freeze incoming video:**
- Click the Freeze button (that looks like a snowflake).
- Choose Color > Resolve Live Freeze (Shift-Command-R).

The snowflake button freezes the image so you can grade a particular frame

### Using Snapshot

Once you’re happy with a grade, clicking the Snapshot button saves a snapshot of the current still in the Viewer, the incoming timecode value, and your grade into the Timeline. Snapshots are simply one-frame clips. They use grades and versions just like any other clip. In fact, ultimately there’s no difference between the timeline created by a Resolve Live session and any other timeline, other than that the Resolve Live timeline only has a series of one frame clips, which appear in the Timeline of the Edit page as a series of 1-frame stills.

**To save a snapshot, do one of the following:**
- Click the snapshot button (with a camera icon).
- Choose Color > Resolve Live Snapshot (Command-Option-R).

The snapshot button saves a frame and the grade for future use
For example, you may begin the process of building and refining a grade for a particular scene during an unrecorded run-through. Then, once shooting starts, you may take snapshots of each shot’s slate, and then of significant takes that follow, tweaking where necessary and in conjunction with the DP’s feedback once things get going. New camera setups may require further tweaks, which you’ll save as snapshots for those shots, and as you work in this way you’ll find yourself building up a timeline of snapshots that correspond to that day’s shoot.

As you work, keep in mind that you must temporarily turn Resolve Live off in order to open a grade from a previous snapshot in the Timeline, in order to use it as a starting point for another shot. You can also save grades into the Gallery.

**Using Resolve Live Grades Later**

Since each Snapshot you capture during a Resolve Live session contains timecode that was captured from the camera, grades from snapshots with timecode that overlaps recorded camera original media can be synced using ColorTrace when the time comes to start making dailies.

Keep in mind that snapshot grades correspond to the monitored output of the camera during the shoot. If you shot using a raw format, you’ll need to use whatever in-camera debayering settings were used for monitoring during the shoot if you want the grades from your snapshots to produce the same result.

For more information on using ColorTrace, see Chapter 146, “Copying and Importing Grades Using ColorTrace.”

**Using LUTs in Resolve Live Workflows**

Many on-set workflows use Lookup Tables (LUTs) to calibrate displays, normalize log-encoded media for monitoring, and preview looks in the video village to test how the current lighting scheme will work with the intended grade. You can apply LUTs using the Lookup Tables section of the Project Setting’s Color Management panel, or within a grade as part of a node tree.

However, you can also export LUTs, if necessary for monitor previewing, that you can apply by loading them into a compatible LUT box of some kind, connected in-between the camera’s video output and a display, or using a display capable of loading LUTs internally.

If you’re exporting LUTs using the Generate 3D LUT command of the Thumbnail timeline’s contextual menu, you should limit yourself to using only Primaries palette and Custom Curves palette controls within a single node. These are the only grading controls that can be mathematically converted into a LUT.

When exporting a LUT, any nodes that use Windows or OpenFX will be ignored along with all corrections made within these nodes. All other nodes with Primaries palette and Custom Curves palette adjustments that can be translated into a LUT will have their combined result translated into a LUT. For any nodes that mix supported and unsupported adjustments for LUT export (such as sharpening or blur filtering operations), the unsupported adjustments will simply be ignored. For more information on exporting LUTs, see “Exporting Grades and LUTs” in Chapter 139, “Grade Management.”

**NOTE:** DaVinci Resolve exports LUTs in the .cube format, which is a DaVinci-developed LUT format, with no relation to the Adobe SpeedGrade.cube format.
DaVinci Resolve has robust support for a wide variety of stereoscopic workflows. Using the built-in tools of the Studio version of DaVinci Resolve, you can edit using stereoscopic clips, grade the resulting program, adjust each clip’s stereo-specific properties such as convergence and floating windows, and master stereoscopic output, all within DaVinci Resolve.

Contents

- Stereoscopic Workflows
- Hardware Requirements for Working in Stereo 3D
- Setting Up to Display Stereo 3D via SDI
- Setting Up to Display Stereo 3D via HDMI
- Supported Stereo 3D Media
- Using Dual Sets of Media in Any Supported Format
- Using Stereoscopic OpenEXR Media
- Using Stereoscopic CineForm Media
- Creating Stereo 3D Clips From Separate Files
  - Step 1—Import and Organize Your Media
  - Step 2—Generate 3D Stereo Clips
  - Step 3—(Optional) Create Optimized Media
- Monitoring Stereoscopic 3D in the Edit Page
- Converting Clips Between Stereo and Mono
- Converting Stereo Clips Back to Mono
- Converting Mono Clips or an Entire Timeline to Stereo
- Attaching Mattes to Stereo 3D Clips
Creating a stereo 3D project is a multi-step process that benefits from careful media organization. This chapter covers how to set up for working on stereoscopic projects, how to import stereoscopic projects, and how to export stereoscopic media.

First, stereoscopic pairs of clips, i.e., the individual left- and right-eye media files, are imported into the Media Pool, organized, and then linked together using the “Stereo 3D Sync” command to create a new set of linked stereo clips. Then, these clips stereo clips can be either edited or conformed to imported project data using a single Timeline. DaVinci Resolve lets you manage left- and right-eye grades and sizing in the Color page using the controls found in the shortcut menu of the Thumbnail timeline, and in the Stereo 3D palette.

If you’re using stereoscopic CineForm media, which contains muxed left-eye and right-eye image data that can be decoded by DaVinci Resolve, you still need to go through this process, although you’ll be using duplicate clips to populate Left and Right folders with matching sets of clips.

**Hardware Requirements for Working in Stereo 3D**

With DaVinci Resolve on Mac systems, dual 4:2:2 Y’CbCr stereoscopic video streams are output via SDI from a compatible Blackmagic Design video interface. You can select either Side-by-Side or Line Mesh output to be fed to your stereo 3D-capable display, depending on its compatibility. Alternately, if you turn on the “Enable Dual SDI 3D Monitoring” checkbox in the Video Monitoring group of the Master Settings panel of the Project Settings, your compatible Blackmagic Design video interface outputs full resolution 4:2:2 Y’CbCr for each eye to compatible displays.
When setting up a 3D-capable DaVinci Resolve workstation, keep in mind that the dual video streams of 3D projects make greater demands on disk bandwidth, media decoding via your workstation’s CPU, and effects processing via your workstation’s available GPU cards.

**Setting Up to Display Stereo 3D via SDI**

All DaVinci Resolve systems can output a side-by-side frame-compatible signal that can be viewed on a stereo 3D-capable display via a single SDI connection, output from a DeckLink HD Extreme card or better. For higher-quality monitoring, two SDI signals can be used to output the left-eye and right-eye images separately at full resolution using one of the following Blackmagic Design video interfaces:

- DeckLink HD Extreme 3D+
- DeckLink 4K Extreme
- DeckLink 4K Extreme 12G
- DeckLink 8K Pro
- UltraStudio 4K
- UltraStudio 4K Extreme
- UltraStudio 4K Extreme 3

Very old legacy systems accomplish this via NVIDIA dual SDI monitoring outputs.

**NOTE:** If your stereo display is not capable of multiplexing the two incoming SDI signals by itself, you can accomplish this using an external device to multiplex both SDI signals into a single stereo 3G signal that will be compatible. Check with your display manufacturer in advance to see if this is necessary.

The following procedures describe how to set up stereo 3D monitoring in two different ways.

**Monitoring via dual SDI to dual SDI:**

1. Open the Master Settings panel of the Project Settings, then do the following:
   - Make sure the Use 4:4:4 SDI checkbox is unchecked.
   - Turn on the “Use dual outputs on SDI” checkbox.

2. Open the Stereo 3D palette in the Color page, and do the following:
   - Set Vision to Stereo.
   - Set the Out pop-up menu to None.

**NOTE:** When “Enable dual SDI 3D monitoring” is turned on, split-screen wipes and cursors will not be visible on the grading monitor, nor will you be able to view image resizing.

**Setting Up to Display Stereo 3D via HDMI**

If your stereo-capable display only has HDMI input, you’ll need to use the HDMI output of a compatible Blackmagic Design video interface that has HDMI 1.4 or better to output stereo 3D signals; see the documentation accompanying your video interface for more information.
Supported Stereo 3D Media

When importing stereo 3D media from other applications, there are two types of media that are compatible with DaVinci Resolve stereoscopic workflows.

Using Dual Sets of Media in Any Supported Format

When originally shot, the media corresponding to stereo 3D workflows consists of two directories, one for the left-eye media, and one for the right-eye media. For the most automated workflow possible, this media must be tightly organized. Each pair of left-eye and right-eye media files in both directories should have matching timecode, and reel numbers that clearly indicate which are the left-eye shots, and which are the right-eye shots. When organized in this way, it’s relatively easy to use DaVinci Resolve to convert each matching pair of clips into the stereo 3D clips that you’ll need to work in DaVinci Resolve. This process is covered in detail in a subsequent section.

Using Stereoscopic OpenEXR Media

DaVinci Resolve is compatible with stereo OpenEXR files to accommodate professional cinema and specialty workflows. Stereo OpenEXR clips include the media for both eyes stored as separate parts so that a single OpenEXR file may output either a single image or stereo 3D images when used with an application that supports it, such as DaVinci Resolve. This means you can edit stereo OpenEXR media, grade it, and make all of the stereoscopic adjustments that the Stereo palette of the Color page supports.

If you import stereo OpenEXR clips to the Media Pool, they will at first appear to be regular non-stereo clips that output a single image. However, these can easily be converted to stereo 3D clips using the following procedure.

To set stereo OpenEXR clips to be usable as stereo clips:

1. Import the OpenEXR media to the Media Pool as you would any other clips.
2. Select one or more OpenEXR clips, then right-click the selection and choose “Convert to Stereo” from the contextual menu. Those clips will now appear with a stereo 3D badge to indicate that they’re stereo.

Using Stereoscopic CineForm Media

DaVinci Resolve is also compatible with CineForm stereo QuickTime files. CineForm clips encode the media corresponding to both eyes and mux (multiplex) it together in such a way so that CineForm files may output either a single frame of image data, if used in an application that is not capable of stereoscopic processing, or stereo 3D media when used with an application that is, such as DaVinci Resolve. This means that you can edit CineForm media using nearly any NLE, export a project via whatever workflow is convenient, and end up with a stereoscopic project that can be graded in DaVinci Resolve.

There are two ways of creating CineForm files. One is by using a camera or recording system that processes dual synchronized video signals to create a single set of CineForm media. The other is to use the CineForm conversion tools that come with GoPro CineForm Studio to reprocess dual sets of stereo 3D assets into the CineForm format.

The CineForm codec itself encodes full-frame image data using wavelet compression, at any resolution, at up to 12-bits, in a choice of RGB, Y’CbCr, or RAW color spaces. DaVinci Resolve is compatible with CineForm in a QuickTime wrapper using any supported color space, allowing access to the dual streams of image data that are provided.
When the time comes to output your program, keep in mind that while DaVinci Resolve can read CineForm files, CineForm files cannot be rendered out of DaVinci Resolve unless you’ve purchased an encoding license for OS X or Windows from GoPro. Furthermore, DaVinci Resolve cannot render Stereoscopic CineForm files.

If you import stereo CineForm clips to the Media Pool, they will at first appear to be regular non-stereo clips that output a single image. However, these can easily be converted to stereo 3D clips using the following procedure.

**To set stereo CineForm clips to be usable as stereo clips:**

1. Import the CineForm media to the Media Pool as you would any other clips.
2. Select the CineForm media you need to convert, then right-click the selection and choose “Convert to Stereo” from the contextual menu. Those clips will now appear with a stereo 3D badge to indicate that they’re stereo.

---

**Creating Stereo 3D Clips From Separate Files**

If you’re working with stereo media that was either captured or created as individual left- and right-eye files, then you need to convert each matching pair of clips into the stereo 3D clips that you’ll need to work in DaVinci Resolve. This is a two-step procedure.

**Step 1—Import and Organize Your Media**

You need to import all of the left-eye and right-eye media into separate bins.

1. Open the Media page, and create three Media Pool bins named “Left,” “Right,” and “Stereo Clips.” The exact names are not important, but the way the media is organized is.
2. Import all left-eye media into the “Left” bin, and all right-eye media into the “Right” bin. If you’re importing stereoscopic Cineform media, you still need to create this kind of organization, which requires you to place duplicates of each clip into each of the “Left” and “Right” bins.

**Step 2—Generate 3D Stereo Clips**

Once you’ve organized your media appropriately, you’re set up to synchronize the left- and right-eye clips using timecode.

1. Create a new bin in the Media Pool, and name it “Stereo Clips.” This is the bin that will eventually contain the linked stereo clips you’re about to create.

2. Right-click anywhere within the Media Pool and choose Stereo 3D Sync.

---

How to organize media for working in stereo 3D
The Stereo 3D Sync dialog appears, with buttons for choosing the left-eye folder, choosing the right-eye folder, choosing the output folder, and checkboxes for specifying whether to match reel names and file names, and additional fields for entering characters that identify left- and right-eye clips.

3 Click the Browse button corresponding to “Choose left eye folder” and then use the hierarchical list of bins that appears to choose the bin you named “Left.” Follow the same procedure to choose the right-eye media.

4 Click the Browse button corresponding to “Output folder” and then use the hierarchical list of bins that appears to choose the bin you named “Stereo Clips.”

5 Choose which matching criteria to use. Ideally, you only need to use whichever one of the three criteria that apply. The three options are:
   - **Match Reel Name**: If the reel names of the left- and right-eye media match, turn this checkbox on.
   - **Match File Name checkbox**: If the file names of the left- and right-eye media match, turn this checkbox on.
   - **Left Identifiers and Right Identifiers fields**: If the left- and right-eye clips are identified by a special subset of characters within the file name (for example, “3D_R” and “3D_L”), then you can type each into the appropriate field, and these characters will be used to match the left and right eyes together.

6 Click Sync.

The original clips in the Left and Right bins disappear, and a full set of Stereo 3D clips appear in the output bin you selected in step four.
Step 3—(Optional) Create Optimized Media

If your stereo media is excessively large, you can create optimized media.

1. Select the stereo clips you’ve created.
2. Right-click one of the selected clips, and choose Generate Optimized Media from the contextual menu. A window appears showing you how long it will take to finish creating optimized media.

Monitoring Stereoscopic 3D in the Edit Page

You can now view a Stereoscopic 3D signal directly from the Edit page. Previously, the Edit page was restricted to left eye for both outputs. The Edit Page Viewer now displays Stereoscopic 3D identically to the Color page Viewer. The 3D palette in the Color page has the stereoscopic controls to select the stereo viewing options (Side by Side, Anaglyph, Line by Line, etc.), as well as adjusting the convergence and other stereoscopic parameters.

Converting Clips Between Stereo and Mono

You also have the option of converting clips between mono and stereo 3D using a pair of commands in the Media Pool.

Converting Stereo Clips Back to Mono

If necessary, you can split one or more stereo clips into mono clips using a single command.

To convert stereo clips into mono clips:

1. Select one or more stereo clips in the Media Pool.
2. Right-click one of the selected clips and choose Split Stereo 3D Clips from the contextual menu.

Afterwards, two new bins are created named Left and Right, containing the individual left- and right-eye clips that you’ve split apart.

Converting Mono Clips or an Entire Timeline to Stereo

Non-stereo clips (for which there are not separate left- and right-eye media files) can be converted into stereo clips either individually or throughout an entire timeline for one of two different reasons:

- You can convert non-stereo clips into stereo for use in a stereo project, so they output properly along with the rest of a stereo timeline, albeit without adjustable convergence or depth effects.

- If you want to grade an HDR and non-HDR version of your program at the same time, converting non-stereo clips to stereo makes it possible for you to a) manage two separate SDR and HDR grades for each clip in a timeline using the left- and right-eye channels, and b) output the SDR and HDR signals separately via your compatible Blackmagic Design interface’s left- and right-eye SDI outputs when you turn on the "Use dual outputs on SDI" checkbox in the Video Monitoring section of the Master Settings panel of the Project Settings.
To convert mono clips into stereo clips:

1. Select one or more non-stereo clips in the Media Pool.
2. Right-click one of the selected clips and choose Convert to Stereo from the contextual menu.

Afterwards, that clip appears in the Media Pool as a Stereo 3D clip, and when edited into a timeline, can expose its controls in the 3D Stereo palette in the Color page.

If you have a timeline full of clips that you’ve just converted into stereo using the above procedure, you need to take the additional step of setting the Timeline to stereo in order to create stereo grades for each clip.

To convert a timeline to have stereo grades for simultaneous HDR/SDR output while grading:

– Right-click a timeline in the Media Pool and choose Timelines > Set Timeline to Stereo.

For more information about using stereo timeline workflows for simultaneous HDR and SDR grading, see Chapter 8, “Data Levels, Color Management, and ACES.”

Attaching Mattes to Stereo 3D Clips

If you have left- and right-eye mattes that need to be attached to stereo clips, the process works identically to importing mattes for regular clips, except that when you’ve selected a stereo 3D clip in the Media Pool, you have two matte import commands, “Add As Left Eye Matte,” and “Add As Right Eye Matte.”

Organizing and Grading Stereo 3D Dailies

A common workflow is the creation of digital dailies within DaVinci Resolve before editing in an NLE. This provides the editors, director, and producers with the advantage of having more attractive media to work with, that’s also more comfortable to view if handled with the automatic geometry and color-matching functions that match the media of each pair of shots together for a preliminary left- and right-eye balance. The resulting Timelines can then be output to whichever media format is most convenient to use.

Step 1—Create 3D Stereo Clips

The very first step in the process of creating dailies is to import all of the left-eye and right-eye media into individually organized bins, and to then link them together to create stereo 3D clips, as described in the previous section.

Step 2—Edit the New Stereo Clips Into One or More Timelines for Grading

Now that you’ve created a set of Stereo 3D clips, you’re ready to edit them into one or more Timelines for grading. You can do this by simply creating a new Timeline and deselect the Empty Timeline checkbox. A new Timeline will be created with the stereo 3D clips you created.

Step 3—Align Your Media

For the stereoscopic effect to work without causing headaches, it’s critical that both eyes are aligned. This can be tricky to adjust using manual controls, but is something that can be automatically analyzed. You can perform stereo 3D alignment to a single clip using the Stereo 3D Palette controls, or you can select a range of clips to align all of them automatically at once. There are two methods of alignment; which is more appropriate depends on the type of geometry issues you have to address.
– **Transform Alignment**: Analyzes the image and makes vertical and rotational adjustments to line up the left- and right-eye images as closely as possible.

– **Vertical Skew**: Analyzes the images and makes a vertical-only adjustment to line up the left- and right-eye images.

**Controls for aligning the left- and right-eye media**

### Step 4—Grading Stereo Media

Grade the clips in the Timeline as you would any other digital dailies, with the sole addition of using the controls in the Stereo 3D palette to control monitoring and manage the adjustments made to each eye as necessary. As when creating any other kind of dailies, you can use LUTs, the Timeline Grade, and individual clip grading to make whatever adjustments are necessary to create useful media for editing.

**Grading Windows**

If you’re using windows, The Color group of the General Options panel of the Project Settings has a checkbox called “Apply stereoscopic convergence to windows and effects” that correctly maintains the position of a window that’s been properly placed over each eye when convergence is adjusted.

**You must turn on a checkbox in the Project Settings to enable stereo convergence for windows**

When this option is enabled, the Window palette displays an additional Transform parameter, “Convergence,” that lets you create properly aligned convergence for a window placed onto a stereoscopic 3D clip.

**The Convergence control in the Transform section of the Window palette**

After placing a window over a feature within the image while monitoring one eye, you can enable Stereo output in the Stereo 3D palette and use the Pan and Convergence controls to make sure that window is properly stereo-aligned over the same feature in both eyes. At that point, adjusting the Convergence control in the Stereo 3D palette correctly maintains the position of the window within the grade of each eye.
Matching Media From Left and Right Eyes

To help you manage the visual differences between left- and right-eye clips, there are also three automatic color matching commands that can be used to batch process as many clips as you need to adjust at once.

- **Stereo Color Match (Primary Controls):** Uses the Lift/Gamma/Gain controls to match one eye to the other. The result is a simple adjustment that's easy to customize, but may not work as well as Custom Curves in some instances.
- **Stereo Color Match (Custom Curves):** Uses the Custom Curves to create a multipoint adjustment to match one eye to the other. Can be more effective with challenging shots.
- **Stereo Color Match (Dense Color Match):** Performs a pixel by pixel, frame by frame color match that is incredibly accurate. This operation is processor intensive, so if you're going to batch process many clips, or if you're matching long clips, you'll want to make sure you have adequate time. Because this is such a precise match, it's recommended to use Dense Color Match after you've used one of the stereo alignment commands.

Controls for matching the grade of the left and right eye media

Step 5—Output Offline or Online Media for Editing

When you're done applying whatever grading is necessary to make the media suitable for editing, you'll need to export each clip as separate left- and right-eye clips using the controls of the Deliver page.

1. Open the Deliver page, and set up your render to output the format of media you require. Be sure to do the following:
   - Set Render Timeline As to Individual source clips.
   - Turn on the "Filename uses Source Name" checkbox.
   - To render both eyes' worth of media, choose “Both eyes as” from the Render Stereoscopic 3D option, and choose Separate Files from the accompanying pop-up menu. Optionally, you could also choose to render only the left-eye or right-eye media.

2. Choose how much of the Timeline to render from the Render pop-up menu in the Timeline toolbar; to render everything, choose Entire Timeline.
3 Click “Add Job to Render Queue.”

4 Click Start Render.

DaVinci Resolve will now render either two sets of left- and right-eye clips, or one set of media corresponding to the eye you chose.

To make sure that the resulting edited project conforms easily to the originating DaVinci Resolve project, it’s important to be sure that you render individual source clips, and that you turn on the “Filename user Source Name” checkbox, in order to clone the timecode, reel numbers, and file names of the source media.

### Conforming Projects to Stereo 3D Media

Since DaVinci Resolve manages stereo via a single set of specially created stereo 3D clips, you can use the same project import methods to import stereo 3D projects as you would for any other project. Only a single imported timeline is necessary.

This also means that you can edit stereo projects in NLEs that aren’t otherwise stereo-aware, and finish them in full stereo 3D in DaVinci Resolve. To do this, you need to make sure that you edit the left-eye media in your NLE, and then export either an EDL or XML file to conform in DaVinci Resolve.

To conform an EDL to stereo 3D media:

1 Open the Media page, and create the necessary set of stereo 3D clips that will correspond to the project you’re going to import, as described previously.

   Open the Edit page, and then use the Import AAF/EDL/XML command to import your edit.

2 When the Load EDL/XML dialog appears, do the following:
   – If importing an EDL, verify that the frame rate is correct, and click OK.
   – If importing XML, make sure you turn off the “Automatically import source clips into Media Pool” checkbox, since you want to relink the imported project to the stereo 3D clips you created in step one.

The left-eye media timecode and reel information that’s embedded within each stereo 3D clip will be used to conform the stereo 3D clips with the imported EDL, and you should be ready to work.

### Grading Mastered Stereoscopic Media From Tape

If you’ve been handed a stereo 3D muxed tape with a mastered program that needs to be graded, but you haven’t been given a project file or EDL, you can ingest it as individual left- and right-eye media files with a supported VTR, such as HDCAM SR with 4:2:2 x 2 mode, by turning on the “Use left and right eye SDI” checkbox in the Capture and Playback panel of the Project Settings. When muxed stereoscopic signals are ingested, each eye is separated into individual left-eye and right-eye image files.

Once ingested, you can use Scene Detection to split the left-eye media in one bin, and to create an EDL, you can use to split the right-eye media in the same way in another bin, so that you can create a sequential set of stereo clips for grading.
Adjusting Clips Using the Stereo 3D Palette

Once you’ve either created or imported a stereoscopic 3D-identified timeline, you’re ready to begin grading. The left eye will be displayed in the Edit and Color pages by default; however, you can right-click on the Timeline and select Stereo 3D Mode to view the other eye. Most colorists work by grading one eye first (typically the left), and rippling their grades to the other eye, making separate adjustments to each eye’s clips when necessary to match undesirable variation between cameras. DaVinci Resolve lets you do this automatically.

Setting up stereo 3D media enables the Stereo 3D palette on the Color page. This palette contains all the controls necessary for working on stereoscopic projects. It provides controls for choosing which eye to grade, adjusting convergence, swapping and copying grades and media between matching left- and right-eye clips, auto-processing the color and geometry of left- and right-eye clips to match, stereo 3D monitoring setup, and controls for floating windows.

Your project must contain stereo 3D clips in order to open this palette. For more information on setting up a stereo 3D project, see the “Creating Stereo 3D Clips” section of this chapter.

Stereo Eye Selection

Most colorists work by grading one eye first (typically the left), and rippling their grades to the other eye, making separate adjustments to each eye’s clips when necessary to match undesirable variation between cameras.

The first three buttons in the Stereo 3D palette let you choose which eye to grade while you’re working, as well as whether or not to ripple each clip’s grade to the matching opposite-eye clip. Whenever you switch eyes, the 3D badge above each clip’s thumbnail changes color (blue for right, red for left) and the thumbnails themselves update to show that eye’s media.

- **Left button**: Displays the left-eye image and grade.
- **Ripple Link button**: When enabled (orange), all changes you make to the grade of the currently selected eye are automatically copied to the correspondingly opposite eye. When disabled (gray), grades made to the currently selected eye are made independently.
- **Right button**: Displays the right-eye image and grade.
You can also choose which eye you’re viewing and grading by right-clicking a clip’s thumbnail and choosing Stereo 3D > Switch Eye or by choosing View > Switch Eye To > Left Eye or Right Eye.

**Using Ripple Link When Grading Stereo 3D Clips**

You would turn Ripple Link off to suspend rippling when you want to make an individual adjustment to the grade of one eye to obtain a better match between the two. When you’re finished matching the two clips, you can turn it back on to resume automatic grade rippling.

Stereo 3D grade rippling is always relative, so differences between the grades that are applied to the left- and right-eye clips are preserved. In fact, when you add or remove nodes to or from one eye, the same nodes are automatically added to or removed from the corresponding clip it’s paired with, regardless of whether or not Ripple Linked is enabled.

**IMPORTANT**

Regardless of whether or not Ripple Link is enabled, local versions created for one stereo 3D-identified clip are automatically available to the paired timeline.

**Stereo 3D Geometry Controls**

The next group of parameters lets you adjust the geometry of stereo 3D clips. The Pan, Tilt, and Zoom controls are provided as a convenience, and simply mirror the same parameters found in the Transform palette’s Input mode, but made specific to the geometry of the left- and right-eye media. Convergence, Pitch, and Yaw are the three parameters that are unique to the Stereo 3D palette.

- **Convergence**: Adjusts the disparity between the left and right eyes, to define the point of convergence (POC), or the region within the image where the left- and right-eye features are in perfect alignment. If necessary, Convergence can be animated using the Stereo Format parameter group in the Sizing track of the Keyframe Editor. If you want to adjust convergence in pixels, open the Stereo 3D palette option menu, and turn on “Show convergence in pixels.”

  Features that overlap perfectly in both right- and left-eye clips are at zero parallax, putting that feature’s depth at the screen plane. Matching features that are divergent in the left- and right-eye clips have increasingly positive parallax, and appear to be farther away from the audience. Matching features that are divergent and reversed in the left- and right-eye clips have increasingly negative parallax, and appear to be closer to the audience than the screen plane.

- **Linked Zoom button**: When enabled (white), both the left- and right-eye clips are automatically zoomed whenever Convergence is adjusted so that both eyes always fill the screen. When disabled (gray), changes to Convergence will cause the opposing left and right edges of each eye’s clip to have blanking intrude.

- **Pitch**: Pivots the image around the horizontal center plane of the frame.

- **Yaw**: Pivots the image around the vertical center plane of the frame.
Sizing Repositioning in Stereo 3D

Generally, you’ll want to reposition stereo 3D clips with Ripple Link turned on, but you may occasionally find yourself needing to make a manual adjustment to one eye in particular with Ripple Link disabled. As with color adjustments, Sizing adjustments made with Ripple Link disabled are only applied to the clip in the current Timeline. When Ripple Link is turned on, all Sizing adjustments are automatically copied to the correspondingly numbered shot of the other stereo 3D timeline.

WARNING

It is not advisable to use the Rotate parameter when transforming stereo 3D clips. Geometrically, rotation tilts a stereo pair of clips inappropriately, and ruins the "side-by-side" convergence that’s necessary to create the stereoscopic illusion.

Protecting Stereo Adjustments When Copying Grades

Each version of a grade has independent stereo adjustments stored along with the Sizing settings. To prevent accidental overwrite of convergence and alignment data when copying grades from one clip to another, you can right-click within the Gallery and choose one of the following options to turn them on:

– **Copy Grade**: Preserve Convergence
– **Copy Grade**: Preserve Floating Windows
– **Copy Grade**: Preserve Auto Align

When enabled, these options let you overwrite a clip’s grade without overwriting specific Stereo 3D parameters.

TIP: Stereo 3D and Sizing settings are processed before node-based corrections in the DaVinci Resolve image processing pipeline.

Swap and Copy Controls

Another set of controls at the right of the Stereo 3D palette lets you swap and copy grades, and swap clips, in situations where you need to reverse what’s applied to a pair of left- and right-eye clips.

– **Swap Grade**: Exchanges the grades that are applied to the left- and right-eye clips.
– **Swap Shot**: A checkbox that, when enabled, switches the actual media used by two corresponding left- and right-eye clips. Useful in situations where the eyes of a stereo 3D clip were mislabeled, and you want to switch the clips without rebuilding both EDLs.
– **Copy Right to Left**: Copies the right-clip grade to the corresponding left-eye clip.
– **Copy Left to Right**: Copies the left-clip grade to the corresponding right-eye clip.
Batch Grade Management for Stereo 3D Projects

There are also a series of batch-processing commands that are useful for stereoscopic grading that are available when you right-click one or more selected clips in the Thumbnail timeline:

- **Stereo 3D Batch Copy**: Copies every grade from the left-eye clips to the right-eye clips.
- **Stereo 3D Batch Sync**: Copies grades from one eye to the other only when their node graphs have the same number of nodes. This prevents you from accidentally overwriting a custom grade with a different node structure that was necessary to match two eyes for a problem shot.

The Copy Grade, Swap Grade, Swap Shots, Ripple Link, and Switch Eye commands are also available from the Stereo submenu of the Timeline contextual menu.

Automatic Image Processing for Stereo 3D

It's common during stereoscopic shoots for minor divergences in geometry and color to appear in the source footage. To make the process of grading stereo 3D media less onerous, DaVinci Resolve provides a set of auto-adjustment controls at the right of the Stereo 3D palette that gives you a starting point for matching left- and right-eye clips together.

![Auto align and color match buttons](image)

Options for Auto Processing

You can choose which frame should be used to automatically analyze and process stereo clips using the Alignment and Matching controls from the Stereo 3D palette option menu. You can choose Auto Process > First or Middle, depending on what works best for your media.

Auto Process—Stereo Alignment

For the stereoscopic effect to work without causing headaches, it's critical that both eyes are aligned. This can be tricky to adjust using manual controls, but is something that can be automatically analyzed. You can perform stereo 3D alignment to a single clip, or you can select a range of clips to align all of them automatically at once. There are two options. Which is more appropriate depends on the type of geometry issues you're needing to address.

- **Transform Alignment**: Analyzes the image and makes vertical and rotational adjustments to line up the left- and right-eye images as closely as possible.
- **Vertical Skew**: Analyzes the images and makes a vertical-only adjustment to line up the left- and right-eye images.

To align one or more clips automatically:

1. Select one or more stereo clips in the Thumbnail timeline of the Color page.
2. Choose which frame of each clip you want to use for the analysis by opening the Stereo 3D palette, clicking the Option menu, and choosing Auto Process > First or Auto Process > Middle.
3. Click either of the Stereo Alignment buttons. The button to the left is for Automatic Transform, while the button to the right is for Automatic Vertical Skew.
If you selected multiple clips, then the Stereo Alignment window appears, and a progress bar shows the remaining time this operation will take.

**Auto Process—Color Matching**

Due to the design of different stereo 3D rigs, sometimes the color and contrast of one eye’s media doesn’t precisely match that of the corresponding eye. DaVinci Resolve provides two commands for quickly and automatically matching two eyes together.

- **Stereo Color Match (Primary Controls):** Uses the Lift/Gamma/Gain controls to match one eye to the other. The result is a simple adjustment that’s easy to customize, but may not work as well as Custom Curves in some instances.
- **Stereo Color Match (Custom Curves):** Uses the Custom Curves to create a multipoint adjustment to match one eye to the other. The result can be more effective with challenging shots.
- **Stereo Color Match (Dense Color Match):** Performs a pixel by pixel, frame by frame color match that is incredibly accurate. This operation is processor intensive, so if you’re going to batch process many clips, or if you’re matching long clips, you’ll want to make sure you have adequate time. Because this is so precise match, it’s recommended to use Dense Color Match after you’ve used one of the stereo alignment commands.

**TIP:** For the best results, it’s recommended to use automatic color matching in a separate node, independent of other corrections.

Stereo 3D color match works differently depending on whether or not one of the stereo 3D-paired clips has already been graded. The following procedure shows how to match a pair of left- and right-eye clips before you make any manual adjustments of any kind.

**To match a pair of left- and right-eye clips automatically:**

1. Select one or more clips in the Thumbnail timeline of the Color page.
2. Open the Stereo 3D palette, and click one of the three Color Match controls.

The Color Matching window appears, and a progress bar shows the remaining time this operation will take. You can also use automatic color matching to match an ungraded clip to a paired clip that’s already been graded. This only works for grades consisting of one or more primary corrections; secondary corrections cannot be auto-matched.

**To match an ungraded clip automatically to a paired stereo clip that's graded:**

1. To suspend stereo grade linking temporarily:
   - Open the Stereo 3D palette, and turn off the Ripple Link button.
   - Right-click the Thumbnail timeline, and choose Stereo 3D > Ripple Link > Solo.
2. Make a primary adjustment to a clip in the left-eye timeline to create a simple base grade. The left-eye clip now has a grade, and the right-eye clip does not.
3. Do one of the following to switch eyes:
   - In the Stereo 3D palette, click Right.
   - Right-click the Thumbnail timeline again, and choose Stereo 3D > Switch Eye.

   This procedure only works when you use the Stereo Color Match commands on the ungraded clip of a left- and right-eye stereo pair, to match it to the graded clip.
4. To make the match, do the following:
   - In the Stereo 3D palette, click one of the three color match controls.

Both clips should match one another very closely.
Stereo 3D Monitoring Controls

To output both eyes to a stereo 3D display, you need to click the Vision: Mono or Stereo button, and then choose a display mode from the Out pop-up menu.

Monitoring controls for Stereo 3D

– **Vision**: Click a button to choose between Stereo, where both eyes can be displayed in the Viewer and output to video in a variety of different formats, and Mono, where only one eye is monitored in the Viewer and your video output interface.

– **Out**: A pop-up menu that provides different stereo viewing options for previewing stereo 3D signals in different ways. By default, this option is also linked to the Viewer display Internal Video Scope options. For detailed descriptions of each stereo 3D viewing mode, see the following section, “Stereo 3D Output Options.”

– **Link button**: When enabled, the Viewer and internal video scopes both use the Out pop-up menu’s option for stereo 3D viewing. When disabled, you can choose different stereo 3D viewing options for the Viewer and internal video scopes.

– **Viewer**: Lets you choose a stereo 3D viewing option for the Viewer.

– **WFM**: Lets you choose a stereo 3D viewing option for the internal video scopes.

– **Cbd Size**: If any stereo 3D viewing options are set to Checkerboard, this parameter becomes enabled, and lets you define the size of the checkerboard boxes, in pixels.

Dual 4:2:2 Y’CbCr stereoscopic video streams are output via HD-SDI on selected Blackmagic I/O devices when you turn on the “Use left and right eye SDI output” checkbox on the Master Settings panel of the Project Settings. You can select either Side-by-Side or Line-by-Line output to be fed to your stereo-capable display, depending on your display’s compatibility.

Stereo 3D Output Options

Additionally, the Viewer and video scopes can be set to display both “eyes” in one of a variety of different modes.

– **Side by Side**: Displays both images side by side. Each eye is squeezed anamorphically to fit both eyes into the same resolution as the GUI viewer.

– **Top and Bottom**: Displays both images one over the other. Each eye is squeezed vertically to fit both eyes into the same resolution as the GUI viewer.

– **Line by Line (Even/Odd)**: An interlaced mode where each eye is displayed on alternating lines. The thickness of the lines as seen in the Viewer depends on how zoomed in you are.

– **Checkerboard**: Displays both eyes via an alternating checkerboard pattern. This is an excellent mode for identifying regions of the image where there’s variation in color or geometry between the two eyes.

– **Anaglyph (B/W)**: Each eye is desaturated and superimposed via Red/Cyan anaglyph to show the disparity between both eyes in different regions of the image. Left-eye divergence is red, and right-eye divergence is cyan. Regions of alignment between both eyes appear grayscale.
Anaglyph modes are useful for evaluating the geometric differences between both eyes, as well as for identifying the point of convergence (where both eyes align most perfectly) that places a region of the image at the screen plane.

Red/cyan color coding also identifies the direction of parallax. For any given feature, disparity such that red is to the right and cyan is to the left indicates positive parallax (backward projection away from the audience). Red to the left and cyan to the right indicates negative parallax (forward projection towards the audience).

- **Anaglyph (Color):** Similar to Anaglyph (B/W), except that regions of close alignment are shown in full color. Incidentally, both anaglyph modes can be previewed on ordinary displays using old-fashioned red/cyan anaglyph glasses, enabling stereo 3D monitoring on non-stereo 3D-capable displays.

- **Difference:** Superimposes grayscale versions of both eyes using the difference composite mode. Corresponding left/right-eye pixels that are perfectly aligned appear black, while pixels with disparity appear white. This mode is extremely useful for evaluating geometric differences between both eyes, as well as for identifying the point of convergence, without the distraction of color that the anaglyph modes present.

**NOTE:** Only displays the eye corresponding to the currently selected timeline in the Viewer. However, this option also works in conjunction with the “Use Dual Outputs on SDI” checkbox in the Master Settings of the Project Settings which, when turned on, outputs each eye to an individual HD-SDI output of your Blackmagic I/O card.

---

**Floating Windows**

Floating Windows are meant to correct for “Window violations,” where elements of the image with negative parallax, that project forward from the screen plane towards the audience, are cut off by the edge of the frame. In these instances, differences between the images being shown to the left and right eyes can result in a visual paradox that’s difficult for viewers to reconcile. Specifically, when a forward-projecting element is cut off by the left or right edge of the frame, one eye sees things that the other eye does not.
If the subject is moving quickly, this may not be an issue, but if the cut off (or occluded) element lingers onscreen, it causes problems for viewers that defeat the stereo 3D illusion. The viewer’s binocular vision (or stereopsis) is providing one depth cue, while occlusion is providing a completely different depth cue.

To fix this, you can use Floating Windows to crop the cut off object from the eye on the side of the object that’s cut off, thus eliminating the portion of the stereo image that is unseen to the other eye that causes the problem.

Animating Floating Windows

Floating Windows can be animated using the Float Window keyframing track, found within the Sizing track of the Keyframe Editor, to push the edge of the frame in as needed, and then pull it back out when the partially occluded subject has moved fully into the frame. For more information about animating keyframing tracks, see Chapter 145, “Keyframing in the Color Page.”

Floating Windows have the following controls and parameters.

- **L/R/T/B buttons**: Lets you choose an edge to which to apply a Floating Window. Click the button corresponding to the edge you want to adjust. Each edge has its own position, rotate, and softness settings.
- **Position**: Adds masking to the currently selected edge.
- **Rotate**: Rotates the currently selected edge, letting you create an angled Window.
- **Softness**: Feathers the edge of the currently selected edge, letting you create a soft Window that can be less noticeable to viewers.
To add a Floating Window to fix a Window violation:

1. Choose to which eye you want to add the Floating Window.
   - To apply a Floating Window to eliminate a Window violation on the right-hand side of the screen, click the right eye view.
   - To apply a Floating Window to eliminate a Window violation on the left-hand side of the screen, click the left eye view.

2. Choose which edge you want to adjust by clicking the L or R buttons.
   - To eliminate a Window violation on the right-hand side, click R.
   - To eliminate a Window violation on the left-hand side, click L.

3. Adjust the Position parameter as necessary to crop the portion along the edge of the selected eye that’s not visible in the other.

4. Optionally, if you feel that the Window adjustment you’ve just made is too obvious, increase the Softness parameter to make that edge less noticeable.

Stereo Controls on the DaVinci Control Panel

If you’re doing convergence adjustments and stereographic work throughout a program, you can use many of the controls described in this section from the DaVinci control panel.

To show the Stereo transform controls page on the Transport panel:

1. Press the 3D soft key. The Transport panel’s knobs and soft keys are remapped with all available Stereoscopic commands.

2. When you’re finished, press MAIN.

To show the Floating Windows controls on the Center panel:

1. From the main page of the Center panel, press the 3D soft key. The Floating Windows, Auto Match, and Auto Align controls appear on the Center panel.

2. Press the 3D OVERLAY soft key to expose the Stereoscopic sizing controls on the Transport panel. Press 3D OVERLAY again to return to the ordinary sizing controls.

3. When you’re finished, press the MAIN soft key to exit the 3D control page.

Outputting Stereo 3D Media in the Deliver Page

To render full frame media, you’ll need to render each stereo 3D eye separately using the controls of the Deliver page, outputting whatever media format is required by the client.

Rendering Frame-Compatible Media

Frame-compatible media has both the left- and right-eye images squeezed anamorphically into a single media file. To create frame-compatible media, choose the “Both eyes as” option from the Render Stereoscopic 3D controls at the bottom of the File output options of the Deliver page, and then choose a method of output from the Mesh Options pop-up menu.
You can choose Side-by-Side, Line-by-Line, or Top-Bottom. You can also choose Anaglyph if you want to output a traditional anaglyph red/cyan stereo 3D image for viewing on any display.

**Rendering Individual Left- and Right-Eye Clips**

If your workflow requires you to deliver separate sets of left- and right-eye media, this is easily accomplished by either setting up a render job with “Render Stereoscopic 3D” set to either “Right eye” or “Left eye,” or selecting “Both eyes as” and choosing the “Separate files” option.
Chapter 15

Using Variables and Keywords

This chapter describes how to use metadata variables and keywords to help you manage your clips.

Contents

Using Metadata Variables 285
Where Variables Can Be Used 285
How to Edit Metadata Variables 285
Available Variables in DaVinci Resolve 286
Using Keywords 288
Using Metadata Variables

If you’re an enthusiastic user of clip metadata (and you should be), you can use “metadata variables” that you can add into supported text fields that let you reference other metadata for that clip. For example, you could add the combination of variables and text seen in the following screenshot. Variables, once they’ve been entered, are represented as graphical tags shown with a background, while regular text characters that you enter appear before and after these tags.

As a result, that clip would display “12_A_3” as its name if scene “12,” shot “A,” and take “3” were its metadata. When you do this, you can freely mix metadata variables with other characters (the underscore, as in the example above) to help format the metadata to make it even more readable.

Be aware that, for clips where a referenced metadata field is empty, no characters appear for that corresponding metadata variable’s tag wherever it happens to be used.

Where Variables Can Be Used

Metadata variables are extremely flexible, and can be used to procedurally add metadata to several functions in DaVinci Resolve. Here’s a partial list of where you can use variables.

– **Clip names:** You can use variables in the Clip Name column of the Media Pool in List view, or in the Clip Name field of the Clip Attributes window’s Name panel, to use each clip’s metadata to generate a more readable and useful display name.

– **Other metadata fields in the Metadata Editor:** You can use variables to reference metadata in other fields.

– **Automatic labeling of stills in the Gallery:** You can choose an option from the Color group in the General Options panel of the Project Settings to “Automatically label Gallery stills” in the Gallery.

– **Custom text in the Data Burn palette:** You can use variables to automatically populate metadata in different combinations as a window burn.

– **The Filename field of the Render Settings in the Deliver page:** Using variables, you can automatically set the name of rendered clips to follow any metadata that’s associated with a timeline or individual clip. This is especially useful when you want to generate specific file names when rendering individual source clips.

How to Edit Metadata Variables

Every single item of metadata that’s available in the Metadata Editor can be used as a variable, and several other clip and timeline properties such as the version name of a clip’s grade, a clip’s EDL event number, and that clip’s timeline index number can be also referenced via variables.

To add a variable to a text field that supports the use of variables:

1. Type the percentage sign (%) and a scrolling list appears showing all variables that are available.
2. To find a specific variable quickly, start typing that variable’s name and this list automatically filters itself to show only variables that contain the characters you’ve just typed.
3. Choose which variable you want to use using the Up and Down Arrow keys, and press Return to choose that variable to add.
As soon as you add one or more metadata variables to a field and press Return, the string is replaced by its corresponding text. To re-edit the metadata string, simply click within that field to edit it, and the metadata variables will reappear as the graphical tags that they are.

To remove a metadata variable:
– Click within a field using variables to begin editing it, click a variable to select it, and press Delete.

Available Variables in DaVinci Resolve
The following list describes what metadata variables are available to add.

Clip Metadata
– File Name
– Clip Directory
– Video Codec
– Data Level
– KeyKode

Metadata Editor Metadata
– All Shot Scene metadata
– All Clip Details metadata (see Metadata Editor for more information)
– All Camera metadata (see Metadata Editor for more information)
– All Tech Details metadata (see Metadata Editor for more information)
– All Stereo 3D VFX metadata (see Metadata Editor for more information)
– All Audio metadata (see Metadata Editor for more information)
– All Audio Tracks metadata (see Metadata Editor for more information)
– All Production metadata (see Metadata Editor for more information)
– All Production Crew metadata (see Metadata Editor for more information)
– All Reviewed By metadata (see Metadata Editor for more information)
Media Pool Metadata
- File name
- Reel name
- File path
- Video Codec
- IDT
- Input LUT
- PAR
- Data Level
- Description
- Comments
- Keyword
- Shot
- Scene
- Take
- Roll/Card #
- Input Color Space
- Input Sizing Preset
- Start TC
- End TC
- Optimized Media

Timeline and Project Metadata
- Group
- Timeline Name
- Project Name
- Track Number
- Track Name
- Render Codec

Legacy Metadata
- EDL Tape Number: Tape number extracted from imported EDL
- Render Resolution: Resolution of the rendered file
- EDL Event Number: DaVinci Resolve-generated index number of the clip in the timeline
- Version: Version Name of the rendered file
- Eye: Stereo session, “Left” or “Right”
- Reel Number: Reel Name extracted by DaVinci Resolve from source filename or clip name
- Timeline Index: Event number from imported EDL
Using Keywords

While most metadata in the Metadata Editor is edited via text fields, checkboxes, or multiple button selections (such as Flags and Clip Color), the Keyword field is unique in that it uses a graphical “tag” based method of data entry. The purpose of this is to facilitate consistency with keyword spelling by making it easy to reference both a built-in list of standardized keywords, as well as other keywords that you’ve already entered to other clips.

Once added, keywords are incredibly useful for facilitating searching and sorting in the Media Pool, for creating Smart Bins in the Media and Edit pages, and for use in Smart Filters on the Color page. Reaping these benefits by adding and editing keywords is simple and works similarly to the method of entering metadata variables that’s described above.

To add a keyword:

1. Select one or more clips, then click in the Keyword field of the Metadata Editor, and begin typing the keyword you want to use. As you begin typing, a scrolling list appears showing all keywords that are available using the string of characters you’ve just typed.

2. To find a specific keyword in the list, start typing that keyword’s name and this list automatically filters itself to show only keywords that contain the characters you’ve just typed. Choose which keyword you want to use in the list using the Up and Down Arrow keys, and press Return to choose that keyword to add.

3. If you selected multiple clips, don’t forget to click Save or you’ll lose your changes. If you only selected a single clip, your changes will be saved automatically.

As soon as you add one or more keywords, they appear as a graphical tag. To re-edit any keyword, simply click anywhere within the Keyword field to edit it.

To edit a keyword:

Double-click any keyword to make it editable, then edit it as you would any other piece of text, and press Return to make it a graphical keyword tag again.

To remove a keyword:

Click any keyword to select it, and press Delete.
PART 3

Ingest and Organize Media
Chapter 16

Using the Media Page

The Media page is the primary interface for media import and clip organization in DaVinci Resolve. It’s also where all timelines that you edit in DaVinci Resolve or import from other applications are organized. While timelines and clips are both saved in the Media Pool, it’s central to the way DaVinci Resolve works that the source media used by a project is managed separately from your timelines. In this way, you can manage and update the clips used by timelines with ease, importing and reorganizing clips, switching between offline and online media, and troubleshooting any problems that occur.

The Media page also contains much of the core functionality used for on-set workflows, as well as most of the functions that are used in the ingest, organization, and sound-syncing procedures corresponding to digital dailies workflows.

Contents

Understanding the Media Page User Interface 291
The Interface Toolbar 292
Showing Which Panel Has Focus 292
The Media Storage Browser 293
Playing Media in the Media Storage Browser 293
The Media Storage Browser’s Volume List 294
The Media Storage Browser Area 294
Revealing a Finder Location in the Media Browser 298
Viewer 298
Live Media Preview 299
Understanding the Media Page

User Interface

By default, the Media page is divided into five different areas, designed to make it easy to find, select, and work with media in your project.

Much of the functionality and most of the commands are found within the contextual menus that appear when you right-click clips in the Media Storage browser or Media Pool.
The Interface Toolbar

At the very top of the Media page is a toolbar with buttons that let you show and hide different parts of the user interface. These buttons are as follows, from left to right:

- **Media Storage full/half height button**: Lets you set the Media Storage browser to take up the full height of your display, if you need more area for browsing at the expense of a smaller Media Pool.
- **Media Storage**: Lets you hide or show the Media Storage browser. Hiding the Media Storage browser creates more room for the Viewer.
- **Clone Tool**: Shows or hides the Clone tool, used for cloning media from camera cards or hard drives.
- **Audio Panel**: Hides or shows the Audio Panel.
- **Metadata**: Hides or shows the Metadata Editor.
- **Inspector**: Hides or shows the Inspector Panels.
- **Capture**: Switches the Viewer and Audio Panel to Capture Mode, exposing the controls necessary for cuing up a device-controllable deck, and batch recording from tape.
- **Audio Panel/Metadata Editor full/half height button**: Lets you set the Audio Panel or Metadata Editor to take up the full height of your display, if you need more area for either of those functions.

Showing Which Panel Has Focus

Whenever you click somewhere on the DaVinci Resolve interface using the pointer, or use a keyboard shortcut to “select” a particular panel (such as in the Edit page), you give that panel of the user interface “focus.” A panel with focus will capture specific keyboard shortcuts to do something within that panel, as opposed to doing something elsewhere in the interface.

Disabled by default, checking the “Show focus indicators in the user interface” box in the UI Settings section of the User Preferences causes an orange highlight to appear at the top edge of the focused panel, allowing you to keep track of which part of the current page is taking precedence. You can switch focus as necessary to do what you need to do.
The Media Storage Browser

The Media Storage browser lets you see all of the volumes connected to your workstation, browsing them for media that you want to preview and eventually import into your DaVinci Resolve project in one way or another. Whereas other applications rely on some sort of import dialog, DaVinci Resolve provides the Media page for doing complex media import tasks. To facilitate media import, the Media Storage browser is divided into two areas, the Volume List, and the Media Browser.

Playing Media in the Media Storage Browser

You can select media in the Media Storage Browser to play directly in the Media page Viewer, without importing it, so long as it’s in a format that DaVinci Resolve supports. This is useful for previewing clips that you’re considering using in a project, but it’s also useful for quality control review sessions of media that you’ve exported from DaVinci Resolve. All clips that are played in the Media page Viewer are also output to video, if you have a supported Blackmagic output interface. You can also output the video to a second monitor by choosing Workspace > Video Clean Feed, and selecting your monitor. Additionally, if you choose Workspace > Dual Screen > On, the second computer display is capable of displaying a set of video scopes on the Media page, which can help you QC a program you’re delivering.

Playing DCP and IMF Packages

It’s also possible to use the Media Storage Browser to select and play DCP and IMF packages that have been exported either using EasyDCP or using the native DCP/IMF export capabilities of DaVinci Resolve. Simply locate the package, select it, and play it in the Viewer like any other clip. It will be output to video and analyzed by the video scopes.

DCP and IMF packages can also be imported from Media Storage to the Media Pool for various workflows. For more information, see Chapter 187, “Delivering DCP and IMF.”
The Media Storage Browser’s Volume List

At the left of the Media Storage browser is a list of all volumes that are currently available to your DaVinci Resolve workstation. It’s used to locate media that you want to import manually into your project.

- **Scratch volumes**: Indicated by a usage statistic to the right of the volume name that lists how full that volume is, these are disks that you’ve added to the Media Storage panel of the System Preferences window. The topmost of these scratch disks is used to store Gallery stills and cache files.
- **Available volumes**: Indicated by disk icons, this is a list of all fixed, removable, and network volumes that are currently available to your workstation. When the “Automatically display attached local and network storage locations” checkbox is turned on in the Media Storage panel of the DaVinci Resolve Preferences, new volumes that are attached to your workstation should automatically appear in this list.

This is a hierarchical list; clicking the disclosure triangle to the left of any volume opens up an additional list of that volume’s subdirectories, with additional disclosure triangles next to each subdirectory. Using the Media Storage browser, you can drill down into as many subdirectories as you need to.

Adding Volumes That Don’t Appear in This List

If you need to access a storage volume that doesn’t appear on this list, for example if you’re using the version of DaVinci Resolve that is available in the Apple App Store, then you can right-click anywhere in the background of the Volume list and choose “Add New Location” to open a dialog you can use to choose a volume you want to add.

If you’re using the Apple App Store version of DaVinci Resolve, auto-mounting of attached storage volumes is not enabled automatically. However, you can enable this in the Media Storage panel of the DaVinci Resolve Preferences. For more information, see the DaVinci Resolve Preferences section of Chapter 4, “System and User Preferences.”

Media Storage Browser Favorites

Underneath this is the Favorites area. If there are special directories that you find yourself frequently accessing, you can add them to the Favorites in order to avoid having to traverse complex hierarchies in order to access the media you need. The Favorites can be easily customized and used.

**Methods of organizing favorite file system locations in the Media Storage Browser:**

- **To add a favorite**: Right-click any folder in the Media Storage browser folder list, and choose “Add folder to favorites” from the contextual menu. The new favorite appears at the bottom of the Favorites area.
- **To open a favorite**: Click any favorite to expose the contents of the corresponding directory in the Media Storage browser.
- **To remove a favorite**: Right-click the favorite you want to remove, and choose “Remove folder from favorites” from the contextual menu.

The Media Storage Browser Area

Once you’ve selected a volume or subdirectory in the Media Storage browser, you can view its contents in List view, Thumbnail view, or Metadata view to search through the media that’s available to you as you try to find what you need.
List View

In List view, the following columns are available for sorting media prior to importing it into the Media Pool:

- **File name**: The name of a file.
- **Reel name**: The reel name as it's currently derived according to the Conform Options that are currently chosen in the General Options panel of the Project Settings.
- **Start TC**: The first timecode value in the source media.
- **Start**: The first frame number in the source media.
- **End**: The last frame number in the source media.
- **Frames**: The duration of each clip in frames.
- **Resolution**: The frame size of the source media.
- **Bit Depth**: The bit depth of the source media.
- **Video Codec**: The codec used for the video track of supported media.
- **Audio Codec**: The codec used for the audio tracks of supported media.
- **FPS**: The frame rate of the source media.
- **Audio Ch**: The number of audio channels within the source media.
- **Date Created**: The date a media file has been created.
- **Date Modified**: The date a media file has been changed in some way and saved.
- **Shot**: Additional metadata from media formats that support it.
- **Scene**: Additional metadata from media formats that support it.
- **Take**: Additional metadata from media formats that support it.
- **Angle**: Additional metadata from media formats that support it.
- **Good Take**: Additional metadata from media formats that support it.

If you work in List view, you gain additional organizational control by exposing columns that show the metadata that each clip contains, prior to media being added to your timeline. You can use these columns to help organize your media.

**Methods of customizing metadata columns in List view:**

- **To show or hide columns**: Right-click at the top of any column in the Media Storage browser and select an item in the contextual menu list to check or uncheck a particular column. Unchecked columns cannot be seen.
- **To rearrange column order**: Drag any column header to the left or right to rearrange the column order.
- **To resize any column**: Drag the border between any two columns to the right or left to narrow or widen that column.
- **To sort by any column**: Click the column header you want to sort with. Each additional time you click, the same header toggles that column between ascending and descending sort order.

You can also customize column layouts in the Media Storage area. Once you've customized a column layout that works for your particular purpose, you can save it for future recall.
Methods of saving and using custom column layout:

– **To create a column layout:** Show, hide, resize, and rearrange the columns you need for a particular task, then right-click any column header in the Media Pool and choose Create Column Layout. Enter a name in the Create Column Layout dialog, and click OK.

– **To recall a column layout:** Right-click any column header in the Media Pool and choose the name of the column layout you want to use. All custom column layouts are at the top of the list.

– **To delete a column layout:** Right-click any column header in the Media Pool and choose the name of the column layout you want to delete from the Delete Column Layout submenu.

**Thumbnail View**

While in Thumbnail view, you can scrub through a clip’s icon to see its contents, and you can also click the Clip Info drop-down menu at the bottom right corner of any clip’s thumbnail to see an instant summary of that clip’s vital information, including:

– **File name:** The name of that file.

– **In timecode:** The first frame in the source media.

– **Out timecode:** The last frame in the source media.

– **Duration:** The total duration of the source media.

– **Resolution:** The frame size of the source media.

– **Frame Rate:** The frame rate, in fps, of the source media.

– **Pixel Aspect Ratio:** The aspect ratio of the source media.

– **Codec:** Which codec is used by the source media.

– **Date Created:** The date created metadata from the source media file.

– **Flags:** Flag metadata applied either by the camera that shot the media, in the Metadata Editor, or in the Color page Timeline.

Also while in Thumbnail view, you can use the Thumbnail Sort drop-down menu (between the Search and Option menu) to choose a criteria by which to organize the thumbnails. A wide variety of metadata options appear, including: File Name, Reel Name, Start TC, FPS, Audio Ch, etc. You can also sort in ascending or descending order.

The Thumbnail Sort drop-down in the Media Storage browser
Metadata View

In the Metadata view mode, each clip is represented by its own card with a thumbnail and basic clip metadata information visible. This view is designed to have more metadata information than a thumbnail but more targeted information than the List view. This feature, combined with its sort modes, is a powerful way to organize and reorganize your clips in the Media Pool.

The metadata fields of the Metadata view (from the top down):

- **Thumbnail**: A scrubbable thumbnail image of your clip.
- **Row 1**: A main description field that is variable and determined by the sort order selection.
- **Row 2**: Start Timecode, Date Created, Camera #.
- **Row 3**: Scene, Shot, Take.
- **Row 4**: Clip Name, Comment.

The strength of the Metadata view is the automatic clustering of your clips based on the sort order you choose in the Media Pool Sort By menu, at the very upper-right corner of the Media Pool.

Each different sort mode changes the main description field on the card, as well as re-arranging the Media Pool to reflect the selected organization method.
The sort modes available in the Metadata view are:

- **Bin:** This mode clusters the clips by bin, changes the main description field to clip name, and orders the list by timecode.

- **Timecode:** This mode clusters the clips by creation date, changes the main description field to creation date and start timecode, and orders the list by timecode.

- **Camera:** This mode clusters the clips by camera #, changes the main description field to camera # and start timecode, and orders the list by timecode.

- **Date Time:** This mode clusters the clips by day, changes the main description field to creation date and file name, and orders the list by timecode.

- **Clip Name:** This mode clusters the clips by the first letter of the clip name in alphabetical order, changes the main description field to clip name, and orders the list by timecode.

- **Scene, Shot:** This mode clusters the clips by scene, changes the main description field to scene-shot-take, and orders the list by scene-shot-take.

- **Clip Color:** This mode clusters the clips by clip color name, changes the main description field to creation date and start timecode, and orders the list by timecode.

- **Date Modified:** This mode clusters the clips by day, changes the main description field to creation date and file name, and orders the list by the last time the clip was modified by the OS filesystem.

- **Date Imported:** This mode clusters the clips by day, changes the main description field to creation date and file name, and orders the list by the date the clip was added to the Media Pool.

- **Ascending:** Orders the Media Pool from lowest numerical value to highest, and alphabetically from A to Z.

- **Descending:** Orders the Media Pool from highest numerical value to lowest, and alphabetically from Z to A.

**Revealing a Finder Location in the Media Browser**

If you drag a folder from the macOS Finder into the Media Storage browser, the Media Storage browser will immediately update to show the location of that folder.

**Viewer**

Clips that you select in any area of the Media page show their contents in the Viewer. The current position of the playhead is shown in the timecode field at the upper right-hand corner of the Viewer.
Simple transport controls appear underneath the jog bar, letting you Jump to First Frame, Play Backward, Stop, Play Forward, and Jump to Last Frame. A jog control to the left of these buttons lets you move through a long clip more slowly; click it and drag to the left or right to move through a clip a frame at a time.

To the right of the transport controls, In and Out buttons let you set In and Out points for the current clip. The Cue buttons move the playhead to these In and Out cue points. The clip’s timecode is also displayed at the top right.

A jog or scrubber bar appears directly underneath the image, letting you drag the playhead directly with the pointer. The full width of the jog bar represents the full duration of the clip in the Viewer.

There’s an additional option for the Media Page Viewer that you can expose by choosing Show Timecode Toolbar from the Viewer option menu. This reveals an info bar at the top of the Viewer that displays the In and Out timecode, as well as the duration of the currently marked section of media.

You can also put the Viewer into Cinema Viewer mode by choosing Workspace > Viewer Mode > Cinema Viewer (Command-F), so that it fills the entire screen. This command toggles Cinema Viewer mode on and off.

### Live Media Preview

Enabled by default, the Live Media Preview setting found in the Viewer options menu (the three-dots menu found at the upper right-hand corner of the Viewer) makes it possible for thumbnails that you’re skimming in either the Media Storage browser or Media Pool to show the skimmed frame in the Viewer. When skimming with Live Media Preview enabled, the playhead that appears in the thumbnail is locked to the playhead displayed in the Viewer’s jog bar. You can turn Live Media Preview on or off.

### Media Pool

The Media Pool is central to the DaVinci Resolve experience. It contains all of the media that you import into the current project, as well as all of the timelines you create. It also contains all media that’s automatically imported along with Projects, Timelines, or Compositions that have themselves been imported into DaVinci Resolve. In the Media page, enough room is given to the Media Pool to make it an ideal place to sort, sift through, and organize the clips in your project. However, the Media Pool is also mirrored in the Cut, Edit, Fusion, Color, and Fairlight pages, so you can access clips as you build timelines, composites, grades, and sound design.
The Bin List

Ordinarily, all media imported into a project goes into the Master bin, which is always at the top of the Bin list and encompasses everything in a given project. However, you can add bins of your own, and the Media Pool can be organized into as many user-definable bins as you like, depending on your needs. Media can be freely moved from one bin to another from within the Media Pool. When working in projects with multiple bins, you can choose to expose the bin structure in one of two ways:

- **Bin list open**: The Bin List button at the upper left-hand corner of the Media Pool lets you open a separate List view showing all bins in your project, hierarchically. Bins that contain other bins appear with a disclosure button to their left, that you can use to show or hide the contents. With the Bin list exposed, it’s easy to organize clips among a large collection of bins.

- **Bin list closed**: When the Bin list is closed, all bins are hidden, and contents of whichever bin is currently selected populate the Media Pool browser.

Showing Bins in Separate Windows

If you right-click a bin in the Bin list, you can choose “Open As New Window” to open that bin into its own window. Each window is its own Media Pool, complete with its own Bin, Power Bins and Smart Bins lists, and display controls.

This is most useful when you have two displays connected to your workstation, as you can drag these separate bins to the second display while DaVinci Resolve is in single screen mode. If you hide the Bin list, not only do you get more room for clips, but you also prevent accidentally switching bins if you really want to only view a particular bin’s contents in that window. You can have as many additional Bin windows open as you care to, in addition to the main Media Pool that’s docked in the primary window interface.
Bins, Power Bins, and Smart Bins

There are actually three kinds of bins in the Media Pool, and each appears in its own section of the Bin list. The Power Bin and Smart Bin areas of the Bin list can be shown or hidden using commands in the View menu (View > Show Smart Bins, View > Show Power Bins). Here are the differences between the different kinds of bins:

- **Bins**: Simple, manually populated bins. Drag and drop anything you like into a bin, and that’s where it lives, until you decide to move it to another bin. Bins may be hierarchically organized, so you can create a Russian dolls nest of bins if you like. Creating new bins is as easy as right-clicking within the Bin list and choosing Add Bin from the contextual menu.

- **Power Bins**: Hidden by default. These are also manually populated bins, but these bins are shared among all of the projects in your current database, making them ideal for shared title generators, graphics movies and stills, sound effects library files, music files, and other media that you want to be able to quickly and easily access from any project. To create a new Power Bin, show the Power Bins area of the Bin list, then right-click within it and choose Add Bin.

- **Smart Bins**: These are procedurally populated bins, meaning that custom rules employing metadata are used to dynamically filter the contents of the Media Pool whenever you select a Smart Bin. This makes Smart Bins fast ways of organizing the contents of projects for which you (or an assistant) has taken the time to add metadata to your clips using the Metadata Editor, adding Scene, Shot, and Take information, keywords, comments and description text, and myriad other pieces of information to make it faster to find what you’re looking for when you need it. To create a new Smart Bin, show the Smart Bin area of the Bin list (if necessary), then right-click within it and choose Add Smart Bin. A dialog appears in which you can edit the name of that bin and the rules it uses to filter clips, and click Create Smart Bin.

Filtering Bins Using Color Tags

If you’re working on a project that has a lot of bins, you can apply color tags to identify particular bins with one of eight colors. Tagging bins is as easy as right-clicking any bin and choosing the color you want from the Color Tag submenu.

For example, you can identify the bins that have clips you’re using most frequently with a red tag. A bin’s color tag then appears as a colored background behind that bin’s name.
Once you’ve tagged one or more Media Pool bins, you can use the Color Tag Filter drop-down menu (the drop-down control to the right of the Bin List button) to filter out all but a single color of bin.

To go back to seeing all available bins, choose Show All from the Color Tag Filter drop-down.

**Sorting the Bin List**

The Bin list (and Smart Bin list) of the Media Pool can be sorted by bin Name, Date Created, or Date Modified, in either ascending or descending order. Simply right-click anywhere within the Bin list and choose the options you want from the Sort by submenu of the contextual menu.

You can also choose User Sort from the same contextual menu, which lets you manually drag all bins in the Bin list to be in whatever order you like. As you drag bins in this mode, an orange line indicates the new position that bin will occupy when dropped.

If you use User Sort in the Bin list to rearrange your bins manually, you can switch back and forth between any of the other sorting methods (Name, Date Created, Date Modified) and User Sort and your manual User Sort order will be remembered, making it easy to use whatever method of bin sorting is most useful at the time, without losing your customized bin organization.
Thumbnail, List, and Metadata Views in the Media Pool

The contents of the Media Pool can be browsed in the following traditional ways:

– **Thumbnail view:** Each clip is represented by an icon, with its file name appearing underneath. When you move the pointer over a clip’s icon, DaVinci Resolve automatically scrubs through that clip, showing you its contents. Also, a Clip Info drop-down menu appears in the lower right-hand corner. Click the Clip Info drop-down to see an overlay appear showing essential information about that clip. In Thumbnail view, you can use the Sort Order drop-down to choose how clips are sorted.

– **List view:** Each clip is represented by an item on a text list. Additionally, multiple columns of information appear, organized by headers. Clicking any header lets you sort the list by that column, in either ascending or descending order.

– **Metadata view:** Each clip is represented by its own card with a thumbnail and basic clip metadata information visible. This view is designed to have more metadata information than a thumbnail but more targeted information than the List view.

For more information about browsing the contents of the Media Pool, see Chapter 17, “Adding and Organizing Media with the Media Pool.”

Display Audio Clip Waveforms in Media Pool and Media Storage

The Media Pool option-menu presents an option to Show Audio Waveforms. When you do so, every audio clip in the Media Pool appears with an audio waveform within its thumbnail area. If Live Media Preview is on in the Source Viewer, you can then scrub through each clip and hear its contents. If you don’t want to see audio waveforms, you can turn this option off.

Metadata Editor

Both the Media and Edit pages have a Metadata Editor. When you select a clip in any area of the Media page, its metadata is displayed within the Metadata Editor. If you select multiple clips, only the last clip’s information appears. The Metadata Editor’s header contains uneditable information about the selected clip, including the file name, directory, duration, video codec, frame rate, resolution, audio codec, sample rate, and number of channels.

Because there are so very many metadata fields available, two drop-down menus at the top let you change which set of metadata is displayed in the Metadata Editor.

– **Metadata Presets (to the left):** If you’ve used the Metadata panel of the User Preferences to create your own custom sets of metadata, you can use this drop-down to choose which one to expose. Surprisingly enough, this is set to “Default” by default.

– **Metadata Groups (to the right):** This drop-down menu lets you switch among the various groups of metadata that are available, grouped for specific tasks or workflows.
The heart of the Metadata Editor is a series of editable fields underneath the header that let you review and edit the different metadata criteria that are available. For more information on editing clip metadata and creating custom metadata presets, see Chapter 18, “Using Clip Metadata.”

Audio Panel

The Audio Panel can be put into one of two modes via an option menu. In the default Meters mode, audio meters are displayed that show the levels of audio in clips you’re playing. In Waveform mode, you can open audio clips side by side with video clips in the Viewer in order to sync them together manually. For more information on manually syncing audio to video, see Chapter 20, “Syncing Audio and Video.”

When set to Levels mode, you can check audio embedded within clips you’ve imported into the Media Pool. As you play a clip, each audio meter shows the levels for whichever of these tracks contain audio. A Mute button in the Viewer lets you disable and enable audio playback.
Dual Monitor Layout

The Media page has a dual monitor layout that provides maximum space for the Media Storage browser and Media Pool on the primary monitor, and an enlarged Viewer, Audio Panel, and Metadata Editor on the secondary monitor, along with a complete set of video scopes for helping you to evaluate media as you organize it.

**To enter dual screen mode:**
- Choose Workspace > Dual Screen > On.

---

To switch which UI elements appear on which monitors:
- Choose Workspace > Primary Display > Display 1 or Display 2, which reverses the contents of both monitors in dual screen mode.
Customizing the Media Page

The Media Page can be customized to create more room in different areas to accommodate specific tasks.

**To resize any area of the Media page:**
- Drag the vertical or horizontal border between any two panels to enlarge one and shrink the other.

**Methods of hiding different parts of the Media page:**
- To toggle the Clone Tool on and off: Click the Clone Tool button in the UI toolbar at the top.
- To toggle the Audio Panel on and off: Click the Audio button in the UI toolbar at the top.
- To toggle the Metadata Editor on and off: Click the Metadata button in the UI toolbar at the top.
- To toggle the Media Storage browser folder list on and off: Click the button at the top-left corner of the Media Browser.
- To toggle the Media Pool Bin list on and off: Click the button at the top-left corner of the Media Pool.

**Methods of organizing favorite file system locations in the Media Storage browser:**
- To add a favorite: Right-click any folder in the Media Storage browser folder list, and choose “Add folder to favorites” from the contextual menu.
- To remove a favorite: Right-click the favorite you want to remove, and choose “Remove folder from favorites” from the contextual menu.

**To return all pages to their default layout:**
- Choose Workspace > Reset UI Layout.

Undo and Redo in DaVinci Resolve

No matter where you are in DaVinci Resolve, Undo and Redo commands let you back out of steps you’ve taken or commands you’ve executed and reapply them if you change your mind. DaVinci Resolve is capable of undoing the entire history of things you’ve done since creating or opening a particular project. When you close a project, its entire undo history is purged. The next time you begin work on a project, its undo history starts anew.

Because DaVinci Resolve integrates so much functionality in one application, there are three separate sets of undo “stacks” to help you manage your work.

- The Media, Cut, Edit, and Fairlight pages share the same multiple-undo stack, which lets you backtrack out of changes made in the Media Pool, the Timeline, the Metadata Editor, and the Viewers.
- Each clip in the Fusion page has its own undo stack so that you can undo changes you make to the composition of each clip, independently.
- Each clip in the Color page has its own undo stack so that you can undo changes you make to grades in each clip, independently.

In all cases, there is no practical limit to the number of steps that are undoable (although there may be a limit to what you can remember). To take advantage of this, there are three ways you can undo work to go to a previous state of your project, no matter what page you’re in.
To simply undo or redo changes you've made one at a time:

- Choose Edit > Undo (Command-Z) to undo the previous change.
- Choose Edit > Redo (Shift-Command-Z) to redo to the next change.
- On the DaVinci control panel, press the UNDO and REDO buttons on the T-bar panel.

**TIP:** If you have the DaVinci control panel, there is one other control that lets you control the undo stack more directly when using the trackballs, rings, and pots. Pressing RESTORE POINT manually adds a memory of the current state of the grade to the undo stack. Since discrete undo states are difficult to predict when you’re making ongoing adjustments with the trackball and ring controls, pressing RESTORE POINT lets you set predictable states of the grade that you can fall back on.

You can also undo several steps at a time using the History submenu and window. At the time of this writing, this only works for multiple undo steps in the Media, Cut, Edit, and Fairlight pages.

**To undo and redo using the History submenu:**

1. Open the Edit > History submenu, which shows (up to) the last twenty things you’ve done.
2. Choose an item on the list to undo back to that point. The most recent thing you’ve done appears at the top of this list, and the change you’ve just made appears with a check next to it. Steps that have been undone but that can still be redone remain in this menu, so you can see what’s possible. However, if you’ve undone several changes at once and then you make a new change, you cannot undo any more and those steps disappear from the menu.

![History Submenu](image)

The History submenu, which lets you undo several steps at once

Once you’ve selected a step to undo to, the menu closes and the project updates to show you its current state.
To undo and redo using the Undo window:

1. Choose Edit > History > Open History Window.

2. When the History dialog appears, click an item on the list to undo back to that point. Unlike the menu, in this window the most recent thing you’ve done appears at the bottom of this list. Selecting a change here grays out changes that can still be redone, as the project updates to show you its current state.

3. When you’re done, close the History window.
Before you can edit or grade media, you need to add it to the Media Pool, which is the central repository of clips in DaVinci Resolve. The Media Pool is a feature-rich environment, giving you many different methods of importing clips into your project and organizing them.

Contents

Copying Media Using the Clone Tool 311
Adding Media to the Media Pool 313
Basic Methods for Adding Media in the Media Page 313
Adding Subclips From the Media Storage Panel 314
Adding Individual Frames From Image Sequences 315
Adding Media Based on EDLs 315
Splitting Clips Based on EDLs 315
Import Clips With Metadata Via Final Cut Pro 7 XML 316
Adding Media With Offset Timecode 316
Adding Media to the Cut, Edit, Fusion, and Fairlight Pages 317
Removing Media From the Media Pool 317
Adding and Removing External Mattes 318
What Are Mattes For? 319
Adding Mattes 319
Using Embedded Mattes in OpenEXR Files 320
### Adding Offline Reference Movies

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>320</td>
</tr>
</tbody>
</table>

### Extracting Audio in Media Storage

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>320</td>
</tr>
</tbody>
</table>

### Manually Organizing the Media Pool

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>321</td>
</tr>
</tbody>
</table>

#### To Select Clips in the Media Pool

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>321</td>
</tr>
</tbody>
</table>

#### Organizing Media into Bins

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>321</td>
</tr>
</tbody>
</table>

### Import and Export DaVinci Resolve Project Bins (.drb)

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>322</td>
</tr>
</tbody>
</table>

### Import and Export DaVinci Resolve Timelines (.drt)

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>322</td>
</tr>
</tbody>
</table>

### Sharing Media Among Projects Using Power Bins

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>323</td>
</tr>
</tbody>
</table>

### Automated Organization Using Smart Bins

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>324</td>
</tr>
</tbody>
</table>

#### Smart Bins Are Only As Good As Your Metadata

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>324</td>
</tr>
</tbody>
</table>

#### Smart Bins Update Their Contents Dynamically

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>324</td>
</tr>
</tbody>
</table>

#### Automatic Smart Bin Creation

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>325</td>
</tr>
</tbody>
</table>

#### Manual Smart Bin Creation

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>325</td>
</tr>
</tbody>
</table>

#### Organizing Smart Bins

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>328</td>
</tr>
</tbody>
</table>

### Duplicating Clips in the Media Pool

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>328</td>
</tr>
</tbody>
</table>

### Duplicating Timelines

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>329</td>
</tr>
</tbody>
</table>

### Choosing How to Display Bins

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>329</td>
</tr>
</tbody>
</table>

#### Using the Media Pool in Thumbnail View

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>330</td>
</tr>
</tbody>
</table>

#### Working With Columns in List View

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>330</td>
</tr>
</tbody>
</table>

#### Editable Description and Comments Columns

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>333</td>
</tr>
</tbody>
</table>

#### Using Metadata View in the Media Pool

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>333</td>
</tr>
</tbody>
</table>

### Finding Clips, Timelines, and Media

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>335</td>
</tr>
</tbody>
</table>

#### Finding Clips and/or Timelines Within the Media Pool

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>335</td>
</tr>
</tbody>
</table>

#### Finding Synced Audio

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>336</td>
</tr>
</tbody>
</table>

#### Finding Timeline Clips in the Media Pool

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>336</td>
</tr>
</tbody>
</table>

#### Finding Timelines in the Media Pool

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>336</td>
</tr>
</tbody>
</table>

#### Finding Media in the Media Storage Panel and Finder

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>336</td>
</tr>
</tbody>
</table>

#### Going Immediately to a File System Location in the Media Browser

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>337</td>
</tr>
</tbody>
</table>

### Tracking Media Usage

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>337</td>
</tr>
</tbody>
</table>

#### Thumbnail Clip Usage Indicators

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>337</td>
</tr>
</tbody>
</table>

#### List View Clip Usage Column

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>337</td>
</tr>
</tbody>
</table>

### Relinking Media Simply

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>338</td>
</tr>
</tbody>
</table>

#### Relink Media

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>338</td>
</tr>
</tbody>
</table>

#### Relink Selected Clips

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>339</td>
</tr>
</tbody>
</table>

#### Change Source Folder

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>339</td>
</tr>
</tbody>
</table>
Copying Media Using the Clone Tool

One of the few things you may want to do before you add media to your project is to clone all camera original media onto a safe set of backup volumes, for redundancy in case any one volume fails. Additionally, you should consider cloning all media to an off-site backup as well.

Whether you’re on-set working as a DIT, or doing data ingest at a post facility, the Clone Tool in the Media page lets you safely and accurately copy media from SD cards, SSDs, or disk drives, to multiple destinations, with a checksum report (based on a choice of six checksum options) written to the root of each destination volume that verifies the absolute accuracy of the duplicate media saved to each destination.

To duplicate media using the Clone Tool:

1. Open the Clone Tool by clicking the Clone button at the far left of the Media Pool toolbar, which reveals the Clone Tool palette.

2. Click the Add Job button at the bottom left to create a new job. A job item appears within the Clone Tool palette, with overlays to guide you through its use.

3. Drag a volume or folder from the Media Storage panel to the “Drop source here” drop zone. Alternately, you can right-click any volume or folder in the Media Storage panel and choose Set As Clone Source.

4. Next, drag one or more volumes or folders from the Media Storage panel to the “Drop destination here” drop zone. Alternately, you can right-click any volume or folder in the Media Storage panel and choose Set As Clone Destination. You can have more than one destination.

5. If you want to preserve the top level folder name from the source volume or folder, click the Clone Tool panel’s option menu, and choose “Preserve Folder Name.” The overall folder structure of the cloned media is always preserved.

6. If you want to change the checksum method used by DaVinci Resolve to verify that each clip has copied properly, you can choose an option from the Checksum submenu of the Clone Tool’s option menu. Each option is a tradeoff between the speed of your file copy operation and the security of the verification process. Greater security generally means a slower copy operation.

The options are:

- **None**: Disables data verification, sacrificing safety for speed.

- **File Size**: Fast, but minimal data verification. Data verification is done simply by comparing the file size of a duplicate file with that of the original. “Collision resistance” refers to whether two files (or a file and an incorrectly duplicated file) may coincidentally have the same comparison value (be it file size, an error-detecting code, or a hash). File Size is very fast, but it’s minimally collision resistant.

- **CRC 32**: Faster than MD5, but less secure. An error-detecting code rather than the hash used by the next three options. A “check value” is generated based on the remainder of a polynomial division of the file’s contents. By comparing the check value derived from an original file with that derived from a copy, data integrity can be verified. This is a much faster data verification scheme than MD5 (the default), but it is significantly less collision resistant.

- **MD5**: This is the default setting. A reasonable tradeoff between speed and security. A hash function generates a 128-bit value that’s unique to a particular file; Data integrity is checked by comparing the hash value generated by the original file to that generated by the copied file. MD5 is not as collision resistant as the SHA options, but it’s a faster operation, and the probability of such collisions in conventional film and video workflows is probably small.
- **SHA 256, SHA 512**: Slower, but more secure. SHA is a more collision resistant hash function than MD5; options are provided for 256- and 512-bit value generation, with 512 being even more collision resistant than 256. However, these options are progressively slower than MD5, and will result in significantly slower copy times. Similarly to MD5, data integrity is checked by comparing the hash value generated by the original file to that generated by the copied file.

7 When you’re ready, click the Clone button to initiate the cloning process.

**To duplicate media quickly using the Clone Tool:**

1 Right-click any volume or folder in the Media Storage panel, and choose Set as Clone Source. A job item appears within the Clone Tool palette, populated by the volume or folder you selected.

2 Next, right-click any volume or folder in the Media Storage panel, and choose Set As Clone Destination. You can do this more than once because you can have more than one destination.

3 If you want to preserve the top level folder name from the source volume or folder, click the Clone Tool panel’s option menu, and choose “Preserve Folder Name.” The overall folder structure of the cloned media is always preserved.

4 When you’re ready, click the Clone button to initiate the cloning process.
Adding Media to the Media Pool

At minimum, you’ll be using the Media page to add clips to a project to begin editing, in preparation to create dailies, or as a prelude to conforming a project using an EDL. All clips you want to work with must first be added to the Media Pool to be available for grading and processing in DaVinci Resolve, regardless of whether or not there’s edited project data to go along with it.

If you import XML or AAF projects, you can choose to automatically import all accompanying media as part of the import process you initiate in the Edit page. However, if you find yourself needing to replace updated effects or stock footage in the Timeline, or you’re called upon to add additional media such as animated titles or superimposed clips for compositing, then you’ll still need to use the Media page to do so.

Whatever kind of project you’re working on, you can add clips to the Media Pool from as many different volumes as you need. All imported clips are linked to the original media on whichever disks you found them; files are not moved, copied, or otherwise transcoded when you add them to the Media Pool. Consequently, it’s a good idea to make sure that all media you want to import into your project has already been copied to a suitably fast volume before importing it.

Basic Methods for Adding Media in the Media Page

There are several ways of adding clips to the Media Pool.

To add individual clips from the Media Storage panel to the Media Pool:

1. Use the Media Storage panel to find a media file to import.
2. If you have multiple bins available in the Bin list, choose the bin you want to add the incoming media to.
3. Do one of the following:
   - Shift-click or Command-click multiple files, then right-click one of the selected files and choose “Add into Media Pool.”
   - Drag a clip from the Media Storage panel browser to the Media Pool or to a specific bin in the Bin list.
4. If a dialog appears asking if you want to change your project to match the criteria, click “Change” to alter the project’s settings, or click “Don’t Change” to continue importing the media while leaving the project at its previous frame rate. Once clips have been imported into the Media Pool, the frame rate cannot be changed again, so choose carefully.

You also have the option of dragging media directly from the file system of supported platforms into the Media Pool.

To drag one or more clips from the File System to the Media Pool (supported platforms only):

1. Select one or more clips in your File System.
2. Drag those clips into the Media Pool of DaVinci Resolve or to a specific bin in the Bin list.
   Those clips are added to the Media Pool of your project.

If you need to add the contents of all directories and subdirectories to the Media Pool as a flat group of media, that’s easily accomplished. A good example of this is when you’re importing camera original media from a cloned file structure, in which clips are organized into subdirectories that are many levels deep. DaVinci Resolve can easily import all of these clips and put them all into the same bin.
To add the entire contents of one or more directories of clips to the Media Pool:

1. Use the Media Storage panel to find and select one or more directories containing media files you need to import.
2. If you have multiple bins available in the Bin list, select the specific bin you want to add the incoming media to.
3. Do one of the following:
   - Right-click the selected directory or directories in the Media Storage panel, and choose “Add Folder into Media Pool” to add only clips from the selected directory. Subdirectories are ignored.
   - Right-click the directory in the Media Storage panel, and choose “Add Folder and SubFolders into Media Pool” to add clips from the selected directory and those from all subdirectories within.
   - Drag one or more selected directories you want from the Media Storage panel’s browser area to the browser area of the Media Pool to add its contents, and the contents of all subdirectories within, to the currently selected bin in the Bin list.

You also have the option of using the directories and subdirectories that organize media in your file system as bins in the Media Pool, so that you can preserve the original organization of your media.

To add all clips and folders in a directory organized into matching folders in the Media Pool:

1. Use the Media Storage panel to find the directory containing the files you need to import.
2. Do one of the following:
   - Right-click the directory and choose “Add Folder and SubFolders into Media Pool (Create Bins)”
   - Drag the folder you want to import from the Media Storage panel to the Bin list of the Media Pool to add that folder, and all subfolders within, as a new bin in the Bin list.

A folder appears in the Media Pool with the same name as the folder you dragged in. All clips and all subdirectories appear within, nested hierarchically in the Media Pool as they were in the file system.

Import Hierarchically Organized Nests of Empty Directories

You can also import a nested series of directories and subdirectories that constitutes a default bin structure you’d like to bring into projects, even if those directories are empty, by dragging them from your file system into the Media Pool Bin list of a project. The result is a hierarchically nested series of bins that mimics the structure of the directories you imported. This is useful if you want to use such a series of directories as a preset bin structure for new projects.

Adding Subclips From the Media Storage Panel

If you’re browsing long source clips in the Media Storage panel, but you only want to import a small segment of a much longer clip into the Media Pool, you can create subclips directly from the Media Storage panel.

To add a subclip from a clip in the Media Storage panel to the Media Pool:

1. Single-click any clip in the Media Storage panel to open it into the Viewer in order to create a subclip without needing to first import that clip into the Media Pool.
2. Set In and Out points in the Source Viewer to define the section you want to turn into a subclip.
3 Do one of the following:
   – Right-click the jog bar and choose Make Subclip from the contextual menu
   – Drag the clip from the Viewer to the Media Pool to add it as a subclip

**Adding Individual Frames From Image Sequences**

If you’re working with image sequences, or with sequentially numbered image files from any source, DaVinci Resolve automatically presents them as clips in the Media Storage panel. This is good if that’s what they are, but there are instances where sets of photos, of which each frame is in actuality a separate media file, are also sequentially numbered. For this reason, you can import individual frames, rather than entire image sequences.

To *add an individual frame from a number sequence of images in the Media Storage panel*:

1. Click the Media Storage panel option menu, and choose Show Individual Frames. Each image sequence is now separated into its individual frames, allowing you to select only the frames you need.
2. Use any of the previous described methods to add the frames you want to the Media Pool as individual clips.

**Adding Media Based on EDLs**

Another strategy for adding media to the Media Pool is to use an EDL to add only the clips it refers to from a directory. This lets you add only the clips that are necessary for conforming a particular imported project before conforming an EDL, and eliminates the need to add too much media to the Media Pool, which might slow you down in the case of projects referencing terabytes of media. Furthermore, you can choose multiple EDLs to base the import on, and many directories to examine.

The EDLs will reference clips via their timecode and sometimes reel name and path. It is these settings and the conform frame rate that you made previously in the Configuration screen that are now used to place images correctly into the Media Pool.

To *add only media used in an EDL to the Media Pool*:

1. If necessary, open the General Options panel of the Project Settings, turn on the “Assist using reel names from the” checkbox, and choose a method with which to extract reel name information from the media files you’re about to import. For more information, see Chapter 18, “Using Clip Metadata.”
2. Right-click a directory in the Media Storage panel, and choose one of the following commands:
   – Add Folder Based on EDLs into Media Pool
   – Add Folder and SubFolders Based on EDLs into Media Pool
3. Using the file dialog that appears, select one or more EDLs to use.

DaVinci Resolve searches the directory hierarchy, either one level deep or all levels deep, for every media file matching the source timecode and the reel ID of an event in one of the selected EDLs.

**Splitting Clips Based on EDLs**

You can also use EDLs to split a media file into multiple clips in the Media Pool, either as an alternate means of “preconforming” a flattened master media file, or to import multiple sections of a longer media file that happen to be referenced by an EDL.
To split and add clips based on an EDL:

1. Right-click a directory in the Media Storage panel, and choose “Split and add into Media Pool.”
2. Using the file dialog that appears, select an EDL to use, and click Open.
3. Choose a frame rate to use to conform the clips to in the “File Conform Frame Rate” dialog, and click OK.
4. Choose a handle size, in frames, and whether or not you want to split unreferred clips from the “Enter handle size for splitting” dialog, and click Split & Add. The media file is split into the component clips specified in the EDL, and added to the Media Pool.

**TIP:** Turning on the Split Unreferred Clips checkbox automatically splits out sections of the file that were not referred to by the EDL you selected, and adds them to the Media Pool separately, giving you access to every piece of media that’s available.

---

**Import Clips With Metadata Via Final Cut Pro 7 XML**

In order to support workflows with media asset management (MAM) systems, DaVinci Resolve supports two additional Media Pool import workflows that use Final Cut Pro 7 XML to import clips with metadata.

To import clips with metadata using Final Cut Pro 7 XML files, do one of the following:

– Right-click anywhere in the background of the Media Pool, choose Import Media from XML, and then choose the XML file you want to use to guide import from the import dialog.
– Drag and drop any Final Cut Pro 7 XML file into the Media Pool from the macOS Finder.

Every single clip referenced by that XML file that can be found via its file path will be imported into the Media Pool, along with any metadata entered for those clips. If the file path is invalid, you’ll be asked to navigate to the directory with the corresponding media. Additionally, the following metadata is imported:

– Clips
– Browser metadata
– Subclips
– Clip Markers, with colors and duration
– Bin Hierarchy

---

**Adding Media With Offset Timecode**

Sometimes source media was created with incorrectly offset timecode, due to mistakes made earlier in the postproduction process. If this offset is consistent, you can use the “Add Folder with Source Offset” command to add media to the Media Pool as clips with a timecode offset.

To add a folder of clips to the Media Pool with offset timecode:

1. Right-click a directory in the Media Storage panel, and choose one of the following commands:
   – Add Folder with Source Offset
   – Add Folder and SubFolders with Source Offset
2. Choose a number of frames with which to offset the timecode from the “Change Frame Offset” dialog, and click Apply.
The media is imported as clips with offset timecode in the Media Pool. However, the original source timecode of the clips on disk has not been altered. All media rendered out of the Deliver page will reflect the offset timecode.

### Adding Media to the Cut, Edit, Fusion, and Fairlight Pages

While adding clips to the Media Pool in the Media page provides the most organizational flexibility and features, if you find yourself in the Cut, Edit, Fusion, or Fairlight page and you need to quickly import a few clips for immediate use, you can do so in a couple of different ways.

**To add media by dragging one or more clips from the Finder to the Media Pool (macOS only):**

1. Select one or more clips in the Finder.
2. Drag those clips into the Media Pool of DaVinci Resolve, or to a bin in the Bin list.
   
   Those clips are added to the Media Pool of your project.

**To use the Import Media command in the Media Pool:**

1. Right-click anywhere in the Media Pool, and choose Import Media.
2. Use the Import dialog to select one or more clips to import, and click Open.
   
   Those clips are added to the Media Pool of your project.

### Removing Media From the Media Pool

If you’ve added clips to the Media Pool that you need to eliminate, this is easy to do, either singly, or in the aggregate.

**To remove clips from the Media Pool, do one of the following:**

- Select one or more clips in the Media Pool, then press the Delete or Backspace key.
- Select one or more clips in the Media Pool, right-click one of the selected clips, and then choose Remove Selected Clips.
- Right-click anywhere in the Media Pool, and choose Remove All Clips in Bin.

**NOTE:** If you’ve turned on “Automatically match master timeline with media pool” in the General Options panel of the Project Settings, you cannot remove all clips from the Media Pool if there are other timelines using that media.

**To remove clips from the Master Timeline (if it’s exposed):**

Open the Edit page, then select one or more clips in the Media Pool, right-click one of the selected clips, and choose “Remove Selected Clips from Master Timeline.” For more information about using the Master Timeline, see Chapter 34, “Using the Edit Page.”
Adding and Removing External Mattes

If you’ve been provided with matte files to accompany one or more media files used by a program you’re grading, you can attach them directly to specific clips in the Media Pool, in order to use them as key sources for a Clip Grade in the Node Editor of the Color page. You can even use matte files that pack multiple mattes within a single piece of media. This can be done by either writing different mattes to each of the red, green, and blue channels of a clip, or by embedding multiple matte passes within a single OpenEXR file.

![Matching RGB and Matte images](image)

When the Media Pool is in Icon view, clips with clip mattes appear with a badge.

![A clip matte, seen in Icon view](image)

Clip mattes appear listed underneath a clip in the Media Pool when it’s in List view.

![A clip matte, seen in List view](image)

Alternately, you can add a timeline matte to the Media Pool, which isn’t attached to any clip, that can be used as a key source in the Color page within any clip’s Clip grade, or within a Timeline Grade. Timeline mattes appear as stand-alone clips in the Media Pool.

![A timeline matte, seen in Thumbnail view](image)
What Are Mattes For?

Matte files are useful for two things. Traditionally, mattes are grayscale media files that identify regions of varying opacity, with white representing solid areas, and black representing transparency. For example, exported clips from a compositing application sometimes are accompanied by one or more matte files that correspond to keys or rotoscoped mattes from the composite. By importing these matte files using the “Add as Matte” command, you can attach them to the clips they belong to in the Media Pool, so that they’re only available to the clips they’re synced to.

However, mattes can also be used as creative tools to apply grain and texture for effect. What a matte does depends on how you connect it in the Node Editor of the Color page. These are media files that you may want to use as mattes for potentially any clip, so they can also be added to the Media Pool as a so-called timeline matte, that can be applied to any clip you want.

**TIP:** If necessary, you can also apply LUTs to both clip mattes and timeline mattes in the Media Pool, simply by right-clicking a matte, and choosing a LUT from the 1D LUT or 3D LUT submenus. This can be helpful for adjusting incorrectly formatted mattes.

Adding Mattes

To use mattes, you need to add them in very specific ways.

**To assign a matte to a clip in the Media Pool:**

1. Select a clip in the Media Pool to which you want to attach an external matte.
2. Select the matching external matte file in the Media Storage panel, right-click it, and choose Add to Media Pool as a Matte.
   
   The matte is attached to the clip as a clip matte. A badge indicates that clip has a matte when the Media Pool is in Icon view, and the matte itself can be seen, if you put the Media Pool into List view, appearing as a nested item underneath the clip it’s attached to.

**Removing mattes from clips in the Media Pool:**

1. Put the Media Pool into List view.
2. Right-click the external matte file you need to remove, and choose Remove Selected Clips.
   
   Removing an external matte clip also removes that matte’s key from any clip grades that use it, such that any clips using it as a key input change from a secondary operation to a primary operation, where the color adjustment affects the entire image.

**To add a timeline matte to the Media Pool:**

1. Make sure no clip is selected in the Media Pool.
2. Select an external matte file in the Media Storage panel, right-click it, and choose Add to Media Pool as a Matte.
   
   The external matte appears in the Media Pool as a timeline matte.

You can also assign mattes to clips directly in the Color page, which can sometimes be faster.

**To assign a matte to a clip in the Color page:**

1. Drag any clip from the Media Pool to the Node Editor.

   That clip appears an an External matte for the current clip’s grade in the Node Editor, and it’s also automatically assigned to the current clip in the Media Pool.

For more information on using external matte clips as keys when grading, see Chapter 143, “Combining Keys and Using Mattes.”
Using Embedded Mattes in OpenEXR Files

If you’re importing OpenEXR files with embedded matte passes, there’s nothing special you need to do, as the mattes are within the clip you’ve just imported into the Media Pool. For more information on how to use mattes within OpenEXR files, see Chapter 143, “Combining Keys and Using Mattes.”

Adding Offline Reference Movies

When moving a project from another application to DaVinci Resolve, it’s useful to export the entire program as a single media file for use as an Offline Reference Movie. Then, you can import this file in a special way to use for dual Viewer comparison in the Edit page, or as a split-screen comparison for fade wipe in the Color page. As of DaVinci Resolve 16 it’s no longer necessary to import reference movies in this way to make an offline comparison, but it can still be convenient when managing multiple timelines and versions that require great specificity.

To add a clip as an offline reference clip:

– Right-click it in the Media Storage panel, and choose “Add As Offline Clip.”

That clip appears with a small checkerboard badge in its icon in the Media Pool, or as the icon to the left of the Media Pool.

Extracting Audio in Media Storage

If there’s a video clip in the Media Storage panel that has audio you need, but you don’t want the video component, you can use the Extract Audio command to create a self-contained audio clip that you can then import into the Media Pool by itself.

To extract the audio from a media file:

1 Right-click a clip in the Media Storage panel, and choose Extract Audio.
2 Click the Browse button in the Extract Audio dialog to find another disk location for the extracted clip.
3 Click Extract. The audio channels are extracted and written as a .WAV file to the selected destination.
4 After you’ve extracted the stand-alone .WAV file, you’ll need to import it into the Media Pool if you want to use it in your project.
Manually Organizing the Media Pool

Whether you’re doing onset work, creating digital dailies, organizing media to edit, or ingesting media to conform to an imported project, it’s vitally important to stay organized. The Media Pool provides many different tools for doing so. This section examines how you can create bins to manually organize collections of clips.

To Select Clips in the Media Pool

There are a variety of ways you can make clip selections in the Media Pool in preparation for relinking, unlinking, moving, duplicating, deleting, or doing any other operation to them.

– Click any clip to select it.
– Drag a bounding box around several clips to select them all.
– Hold the Command or Shift keys down and drag a bounding box around another discontinuous group of clips to either add them to the current selection or remove them from the current selection.
– Click one clip, then Shift-click another to select both clips and make a continuous selection of all clips in-between. Shift-clicking another clip can expand or contract the selection.
– Command-click individual clips to select a discontinuous number of clips. Command-click a clip that’s already selected to individually de-select it, while leaving the rest of the selection alone.
– With one clip selected, hold the Shift or Command keys down and use the Arrow keys to expand the selection to other clips.

Organizing Media into Bins

You can easily organize clips into different bins in the Media Pool. For some workflows, this is required, while with other workflows it’s purely optional.

Methods of working with bins in the Media Pool:

– To add a bin to the Media Pool: Right-click in the Bin list and choose Add Bin. To add a bin inside another bin, right-click any bin and choose Add Bin.
– To move selected clips into a new bin: Select all the clips you want to put into a new bin, then right-click one of the selected clips, and choose Create Bin With Selected Clips.
– To rename a bin: Select the bin you want to rename, and then click its name a second time to make it editable. With the bin name highlighted, type a new name and press Return. Alternately, you can right-click a bin, choose Rename Bin, and then type a new name and press Return.
– To add incoming clips to a specific bin in the Media Pool: Click a bin to select it, then use any of the previously described methods to add media from the Media Storage panel directly to that bin.
– To move media from one bin to another: Drag one or more selected clips from their current location in the Media Pool into that bin. Multiple clips in the Media Pool can be selected by Shift-clicking or Command-clicking them, or by dragging a bounding box over a group of clips. You can also drag one bin into another one.
– To delete a bin: Select the bin you want to delete, and press the Backspace or Delete key. Or, right-click a bin and choose Delete Bin. Deleting a bin with nested bins inside of it results in that entire set of bins being deleted.
– To sort bins: Right-click on any bin, and choose an option from the Sort By submenu. You can choose from Name, Date Created, Date Modified, and User Sort.
To reorganize bins manually: Right-click anywhere within the Bin list, and choose Sort By > User Sort. Then, drag bins up or down in the Bin list to put them into the order you want. An orange dividing line shows where dragged bins will be placed when you drop them and helps you see when a bin you’re dragging will become nested within another bin or not. The User Sort order is saved even when you change to another sort order, and selecting User Sort again results in your custom sort order being recalled.

Import and Export DaVinci Resolve Project Bins (.drb)

You can import/export specific bins from one DaVinci Resolve project to another, allowing you to pass bins quickly between projects and workstations that have access to the same media. All Metadata, In/Out points, Timelines, etc. are transferred along with the clips in the bin, but none of the actual media files are included.

To export bins from the Media Pool:
1. Select one or more bins in the Media Pool.
2. Right-click the selection and choose “Export Bin,” or choose File > Export > Export Bin.
3. Choose where to save the DaVinci Resolve Bin file (.drb) in the file system dialog, and click Save.

To import bins into the Media Pool:
1. Right-click in the Media Pool and choose “Import Bin,” or choose File > Import > Import Bin.
2. Do one of the following:
   – Choose a DaVinci Resolve Bin file (.drb) from the file system dialog.
   – Double click the .drb file in your file system.

The bin or bins will appear in the Media Pool. Any bins imported this way will have the word “import” appended to their name, to avoid duplicate names. If you import a bin that contains clips that were already in the Media Pool, the potentially duplicate clips are excluded from the import and instead relinked to the media referenced by your project. This keeps your Media Pool tidy. However, if the bin or bins have been moved to another computer, you may have to relink offline media.

Import and Export DaVinci Resolve Timelines (.drt)

You can export and import individual timelines from one DaVinci Resolve project into another previously existing DaVinci Resolve project, allowing you to pass timelines quickly between projects and workstations, without creating additional imported project files. Just the timeline and its associated clip information is exported, none of the actual media files are included.

To export a timeline from the Media Pool:
1. Select a timeline from the Media Pool.
2. Choose File > Export > Export AAF, XML, DRT (Shift-Command-O).
3. Choose “DaVinci Resolve Timeline Files (*.drt)” from the format options popup in the file system dialog.
4. Choose where to save the DaVinci Resolve Timeline file (.drt) in the file system dialog, and click Save.
To import a timeline into the Media Pool:

1. Choose a bin in the Media Pool in which you want the imported timeline to be saved.
2. Do one of the following:
   - Choose File > Import Timeline > Import AAF, XML, DRT (Shift-Command-I), then Select a DaVinci Resolve Timeline file (.drt) from the file system dialog, and click Open.
   - Double click the .drt file in your file system.

The timeline will appear in the Media Pool, along with all of the clips associated with it. Any timelines imported this way will have the word “import” appended to their name, to avoid duplicate names. The imported timeline will be automatically conformed to corresponding media that’s already in the Media Pool. However, if the timeline has been moved to another computer, you may have to reimport or relink missing or offline media in to bring the imported timeline fully online.

**NOTE:** Only a single timeline can be imported and exported at a time using this method. To import or export multiple timelines, use the Import/Export Bin function described above.

### Sharing Media Among Projects Using Power Bins

Power Bins provide a way of importing and organizing media that you want to be available to all projects in DaVinci Resolve. Power Bins reside in a separate area of the Media Pool, with resizable dividers separating them from both the ordinary bins and Smart Bins areas. Power Bins are hierarchical, just like regular bins, and you can nest as many as you like, one inside another.
Like regular bins, Power Bins must be manually created by right-clicking within the Power Bins area and choosing Add Bin. The difference is that whatever clips you import into Power Bins are shared among all projects in a single-user installation, or all projects belonging to a particular user in a multi-user installation. In this way, they’re similar to Power Grades in the gallery of the Color page. This makes Power Bins ideal for storing shared media that’s re-used often, such as stock video, sound effects, stills, and things like company slates and network graphics and animations that go into every show of a series.

Power Bins are created and used like any other bin, using the procedures described previously.

**To show or hide the Power Bin area of the Bin list:**

– Choose View > Show Power Bins to toggle the visibility of all power bins on and off.

### Automated Organization Using Smart Bins

A completely automated way of organizing media in the Media Pool is to use Smart Bins that are either automatically or manually created, in order to collect all clips in the Media Pool that have commonalities based on any of the intrinsic or user-editable metadata that’s available in the Metadata Editor and Media Pool. If you’re familiar with the Color page, Smart Bins work much the same way as Smart Filters, and they’re created and edited using much the same procedures. For more information about Smart Filters, see Chapter 124, “Using the Color Page.”

Smart Bins are incredibly flexible. Using one or more metadata-based rules, they can be as simple or sophisticated as you require. They’re even capable of using multiple groups of multiple rules for situations where you need to gather clips that match all of one set of criteria, but only one of a second set of criteria. In this way, you can use Smart Bins to solve a wide variety of organizational needs as you edit your program.

### Smart Bins Are Only As Good As Your Metadata

It’s important to point out, however, that as much intrinsic metadata is available to every clip in DaVinci Resolve automatically (clip properties such as frame rate, frame size, codec, file name, and so on), the more time you take entering extra metadata in the Metadata Editor to prepare your project for editing and grading, the more powerful Smart Bins can be in helping you to sift and sort through the contents of a program you’re grading. Examples of metadata entry that will guarantee immediate benefits from Smart Bins include the entry of scene, shot, and take information, keywords identifying key descriptors (day and night, interior and exterior, framing, and so on), and using Face Detection to assign character names. These categories of metadata can be used for the automatic creation of Smart Bins, but they can also be used in combination when manually creating Smart Bins that are even more specific.

Imagine being able to gather all the clips in a particular scene, find all the interview clips for a particular subject, or find all the establishing shots corresponding to a particular location, all by simply selecting a Smart Bin that automatically examines the current contents of the Media Pool. If you or an assistant can take the time to enter metadata for the source material in a project that identifies these characteristics, you’ll be able to work even more quickly to find the clips you need for any given situation.

### Smart Bins Update Their Contents Dynamically

Smart Bins are always dynamically up to date and include whatever new media is added to the Media Pool. This makes it easy to stay organized, even when working on projects where new media is being added to the Media Pool every day, such as when editing during a shoot. By using metadata entered either in-camera, by the DIT or media wrangler managing ingest, or by an Assistant Editor who’s working with you, Smart Bins will automatically include all clips in the Media Pool that have matching criteria, whether they were added a month ago or a minute ago.
Automatic Smart Bin Creation

The process of adding metadata to your clips can be used for the automatic creation of sets of “Smart Categories,” which are Smart Bins that are generated and organized by the presence of specific categories of metadata and appear in the Smart Bins section of the Media Pool sidebar. To enable or disable this behavior, open the Editing panel of the User Preferences, and use the checkboxes in the Automatic Smart Bins group to choose which metadata automatically creates Smart Bins.

Metadata capable of creating Smart Bins include:

- Clip Keywords
- Marker Keywords
- People Keywords (added via People Detection)
- Scene metadata
- Shot metadata

These categories are hierarchically organized, with each category closed by default to save space. Click the disclosure triangle of any category to reveal all Keyword, People, Scene, or Shot Smart Bins that are available in the current project. Selecting the Smart Category’s top bin lets you see every clip referenced by every Smart Bin inside of it, whereas selecting individual Smart Bins shows you only the clips referenced by that Smart Bin.

Manual Smart Bin Creation

It’s easy to manually create Smart Bins with customized rules to filter very specific collections of media that you want to use.
To show or hide the Smart Bin area of the Bin list:

– Choose View > Show Smart Bins to toggle the visibility of all Smart Bins on and off.

To create a Smart Bin:

1. If necessary, open the Bin list, choose View > Show Smart Bins, then right-click anywhere in the background of the Smart Bin area of the Bin list, and choose Create Smart Bin.

2. In the Create Smart Bin dialog, enter a name for the filter, and use the following controls to create one or more filter criteria (you can have as many filter criteria as you like):

- **Show in all projects checkbox**: Lets you create a persistent Smart Bin that appears in all projects in your database. Smart Bins created this way will be found in the User Smart Bins folder inside every project’s Smart Bin area in the Media Pool.

- **Match options**: For multi-criteria filtering, choosing All ensures that every single criteria you specify is met for a clip to be filtered. Choosing Any means that if only one out of several criteria is met, that clip will be filtered.

- **Filter criteria enable checkbox**: Lets you enable or disable any criteria without having to delete it.

- **Metadata category drop-down**: Lets you choose which category of metadata you want to select a criteria from. Each category of metadata that’s available in the Metadata Editor is available from this drop-down menu. Additionally, Color Timeline Properties (containing many properties unique to the Color page timeline) and Media Pool Properties (containing every column in the Media Pool) provide access to additional metadata you can use for filtering.

- **Metadata type drop-down**: For choosing which exact type of metadata to use, of the options available in the selected metadata category.

- **Metadata criteria drop-down**: Lets you choose the criteria by which to filter, depending on the metadata you’ve selected. Options include “true/false,” integer ranges, date ranges, string searches, flag and marker colors, et cetera.

- **Add filter criteria button**: Lets you add additional criteria to create multi-criteria filters. You could use multiple criteria to, for example, find all exterior clips, that also contain the keyword “Sunset,” that aren’t closeups, in order to find all the exterior long and medium shots in sunset lighting. Additionally, if you Option-click this button, you can add a nested match option in order to create even more sophisticated filters, such as when the filter must match all of one set of criteria, and any of another set of criteria.
A complicated Smart Bin with multiple criteria and a second match option setting

As you’re editing the filter criteria, the thumbnail timeline automatically updates to show you how the Smart Bin you’re creating is working.

3 When you’re done editing the filter criteria, click Create Smart Bin. The resulting Smart Bin appears in the Smart Bin area of the Bin list, at the left of the Media Pool’s browser area.

Once you’ve created a Smart Bin, it appears in the lower half of the Media Pool’s Bin list, alongside every other Smart Bin in that project. This keeps them organized, separate from the manually created bin shown above.

Once you’ve created a Smart Bin, you can re-edit it whenever the situation requires.

Methods of modifying existing Smart Bins:

– **To rename a Smart Bin:** Right-click the Smart Bin you want to rename, choose Rename from the contextual menu, enter a new name, and press Return.

– **To edit a Smart Bin:** Double-click the Smart Bin, then edit the filter criteria, and click OK.

– **To duplicate a Smart Bin:** Right-click any Smart Bin and choose Duplicate from the contextual menu. This is a good way to create multiple variations of a Smart Bin that you created with complex rules, where you need to create variations by modifying those rules without needing to reinvent the wheel each time.

– **To delete a Smart Bin:** Right-click the Smart Bin you want to delete, choose Delete Smart Bin from the contextual menu, and click Delete in the warning dialog. Deleting a Smart Bin does not delete any gathered media associated with that bin.
Smart Bins Work Better With Metadata

Keep in mind that the more metadata you associate with each clip, the more methods you have at your disposal for creating custom Smart Bins (for editing) and Smart Filters (for grading) with which to zero in on the clips you need for any given situation. This will not only make it easier to find what you need, but it’ll help you to work faster. At the very least, it would be valuable for you to use the Metadata Editor to add information to each clip such as a Description, Shot and Scene designations, take information, and possibly some useful keywords such as character names, shot framing, interior or exterior keywords, and so on.

For example, if you’ve entered enough metadata, then you can create multi-criteria Smart Bins or Smart Filters that let you find the equivalent of “every close-up of Sally inside the diner,” or “every long shot of Antonio outside in the parking lot.” In a documentary, you could easily isolate “every interview shot of Louis from camera 1,” or “every B-roll clip with Robyn.” All of this will help you find media faster for editing, or quickly isolate similar clips that you need to match together for grading.

For more information about using the Metadata Editor, see Chapter 18, “Using Clip Metadata.”

Organizing Smart Bins

Manually created Smart Bins can be organized into Folders and Sub-Folders for better sidebar management, just like regular bins.

To add a Smart Bin folder:

Right-click in the Smart Bins area and choose Add Folder from the contextual menu to create folders that you can drag Smart Bins into. Each folder has a disclosure triangle, so you can show or hide its contents.

Another benefit of Folders is that when you select a Folder, you can see the full contents of all Smart Bins inside of it in the Media Pool browsing area. Selecting any one Smart Bin then restricts the Media Pool to showing only the media reference by that Smart Bin.

Folders can be renamed, removed, opened as a new window, or sorted along with all other Smart Bins by right-clicking them and using commands in the contextual menu.

Duplicating Clips in the Media Pool

You can duplicate clips in order to create an instance of that media that’s treated as a completely new source clip, entirely separate from the original instance of that clip that was imported into DaVinci Resolve. The duplicate is capable of storing individualized metadata and markers that are completely distinct from the original clip that was imported into your project.
To duplicate one or more clips:

1. Select one or more clips to duplicate.
2. Do one of the following:
   - Choose Edit > Duplicate Clip
   - Hold the Option key down while dragging one or more selected clips to another bin
   - Right-click a clip in the Media Pool, and choose Duplicate Clip from the Contextual Menu

Adding Clips From the Timeline to the Media Pool

You can also drag one or more clips from the Timeline back into the Media Pool to create a duplicate.

As with duplicating clips in the Media Pool, each duplicate is created as a new source clip that’s entirely separate from the original instance of that clip that was imported into DaVinci Resolve and is capable of storing individualized metadata and markers that are completely distinct from the original clip that was imported into your project.

For example, the original clip in the Timeline remains conformed to the original clip that was first imported into the Media Pool; deleting the original clip from the Media Pool will make that clip “non-conformed” in the Timeline, while the duplicate you just created remains linked and available. If you’re in this situation, you can always turn Conform Lock Enabled off for that clip in the Timeline and reconform the Timeline Clip to the duplicate you just created, but that’s an extra step because the duplicate clip is considered by DaVinci Resolve to be a whole new piece of media that just happens to share the same clip details.

This may seem strange, but there are a variety of finishing workflows that use this capability, so it’s good to know about.

Duplicating Timelines

Timelines can be duplicated for a variety of reasons: to create a backup of a timeline at a specific date, to create a variation of an edit, or to create separately graded versions.

To duplicate a Timeline:

- Select a Timeline in the Media Pool, and choose Edit > Duplicate Timeline.
- Press Command-4 to give focus to the Timeline, and choose Edit > Duplicate Timeline.

Choosing How to Display Bins

Once you’ve created a bin structure for your project, you can customize how your bins are displayed, depending on how you like to work.

Showing Bins in Separate Windows

If you right-click a bin in the Bin list, you can choose “Open As New Window” to open that bin into its own window. That window is basically its own Media Pool, complete with its own Bin list, Power Bins and Smart Bins lists, and display controls.
Multiple Media Pool bins opened as new windows

When multiple Media Pool windows are open, the Workspace > Media Pool Windows submenu lets you bring a floating Media Pool window into focus when you have one or more open and hidden.

This is most useful when you have two displays connected to your workstation, as you can drag these separate bins to the second display while DaVinci Resolve is in single screen mode. If you hide the Bin list, not only do you get more room for clips, but you also prevent accidentally switching bins if you really want to only view a particular bin’s contents in that window.

Using the Media Pool in Thumbnail View

If you work in Thumbnail view using the controls at the top right of the Media Pool, you have the option to resize the thumbnails to make them easier to see, and you can move the mouse pointer over each clip to hover scrub through its contents. Clicking any clip to select it displays it in the Media page Viewer. Whichever clip is currently selected is also output to video for monitoring.

In Thumbnail view, you can use the Sort Order drop-down, at the top right of the Media Pool, between the Icon Size slider and the Icon/List view buttons, to choose how clips are sorted. There are fourteen options: File Name, Reel Name, Clip Name, Start TC, Duration, Type, FPS, Audio Ch, Flags, Date Modified, Date Created, Shot, Scene, and Take.

Working With Columns in List View

If you work in List view using the controls at the top right of the Media Pool, you gain additional organizational control by exposing columns that show the metadata that each clip contains, prior to media being added to your timeline. You can use these columns to help organize your media.

Methods of customizing metadata columns in List view:

- **To show or hide columns**: Right-click at the top of any column in the Media Pool to reveal the column list, and while the column list is open, click the checkboxes of any columns you want to show or hide. Unchecked columns cannot be seen. When you’re finished, click anywhere else in the Media Pool to dismiss the column list.
- **To rearrange column order**: Drag any column header to the left or right to rearrange the column order.
- **To resize any column**: Drag the border between any two columns to the right or left to narrow or widen that column.
- **To sort by any column**: Click the column header you want to sort with. Each additional time you click, the same header toggles that column between ascending and descending sort order.
Once you've customized a column layout that works for your particular purpose, you can save it for future recall.

**Methods of saving and using custom column layouts:**

- **To create a column layout:** Show, hide, resize, and rearrange the columns you need for a particular task, then right-click any column header in the Media Pool, and choose Create Column Layout. Enter a name in the Create Column Layout dialog, and click OK.

- **To recall a column layout:** Right-click any column header in the Media Pool, choose the name of the column layout you want to use from the contextual menu, and choose Load from that item's submenu. All custom column layouts appear at the top of the list.

- **To edit a column layout:** Load the column layout you want to edit, make whatever changes you need to, then right-click any column header in the Media Pool, choose the name of the column layout you just edited from the contextual menu, and choose Update from that item's submenu.

- **To delete a column layout:** Right-click any column header in the Media Pool, choose the name of the column layout you want to delete from the contextual menu, and choose Delete from that item's submenu.

While the available columns of metadata correspond to those fields shown in the Metadata Editor, the available columns in the Media Pool of the Media and Edit pages are a subset of the total amount of metadata that's available, although they represent the most commonly used metadata you'll find yourself referring to when editing and finishing. The available columns in List view include:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>The name of the file on disk that clip is linked to.</td>
</tr>
<tr>
<td>Clip Name</td>
<td>Editing the Clip Name lets you change the name with which clips appear throughout DaVinci Resolve when View &gt; Use Clip Name for Clip Titles is enabled. By default, the clip name mirrors the source clip's file name. When editing the clip name in the List view of the Media Pool, you can use &quot;metadata variables&quot; that you can add as graphical tags that let you reference clip metadata. For example, you could add the corresponding metadata variable tags %scene_%shot_%take and that clip would display &quot;12_A_3&quot; as its name if &quot;scene 12,&quot; &quot;shot A,&quot; &quot;take 3&quot; were its metadata. The clip name can also be edited in the Clip Attributes window. For more information on the use of variables, as well as a list of all variables that are available in DaVinci Resolve, see Chapter 15, &quot;Using Variables and Keywords.&quot;</td>
</tr>
<tr>
<td>Angle</td>
<td>An editable field to contain the angle of the media in a multi-camera shoot.</td>
</tr>
<tr>
<td>Audio Bit Depth</td>
<td>The bit depth of any audio channels in the media file.</td>
</tr>
<tr>
<td>Audio Ch</td>
<td>The total number of audio tracks in the media file.</td>
</tr>
<tr>
<td>Audio Codec</td>
<td>The specific codec used by the audio portion of the media file.</td>
</tr>
<tr>
<td>Audio Offset</td>
<td>Lists the audio offset, in frames, for clips that have been synchronized to separately recorded audio. This parameter is editable in the Media Pool.</td>
</tr>
<tr>
<td>Bit Depth</td>
<td>The bit depth of the media file.</td>
</tr>
<tr>
<td>Camera #</td>
<td>The number assigned to a specific camera.</td>
</tr>
<tr>
<td>Clip Color</td>
<td>The current color assigned to that clip.</td>
</tr>
<tr>
<td>Comments</td>
<td>A user-editable field for entering information about that clip.</td>
</tr>
<tr>
<td>Data Level</td>
<td>The data level setting for the media file.</td>
</tr>
<tr>
<td>Date Created</td>
<td>The date the media file was created.</td>
</tr>
<tr>
<td>Date Modified</td>
<td>The last date the media file was modified.</td>
</tr>
<tr>
<td><strong>Description:</strong></td>
<td>A user-editable field for entering information about that clip.</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Duration:</strong></td>
<td>The total duration of the clip, in timecode.</td>
</tr>
<tr>
<td><strong>End:</strong></td>
<td>The last frame number of the media file.</td>
</tr>
<tr>
<td><strong>End TC:</strong></td>
<td>The timecode value of the last frame in the media file.</td>
</tr>
<tr>
<td><strong>FPS:</strong></td>
<td>The frame rate of the media file.</td>
</tr>
<tr>
<td><strong>File Path:</strong></td>
<td>The file path where that media file is located on disk.</td>
</tr>
<tr>
<td><strong>Flags:</strong></td>
<td>Which flags, if any, have been added to a media file.</td>
</tr>
<tr>
<td><strong>Format:</strong></td>
<td>The image format used by that clip, such as QuickTime, MXF, WAVE, and so on.</td>
</tr>
<tr>
<td><strong>Frame/Field:</strong></td>
<td>Whether that media file is progressive or interlaced.</td>
</tr>
<tr>
<td><strong>Frames:</strong></td>
<td>The total duration, in frames.</td>
</tr>
<tr>
<td><strong>Good Take:</strong></td>
<td>An editable field to contain the circled state of media, relative to the script supervisor’s notes.</td>
</tr>
<tr>
<td><strong>H-FLIP:</strong></td>
<td>Whether that media file is horizontally flipped in DaVinci Resolve.</td>
</tr>
<tr>
<td><strong>HDRX:</strong></td>
<td>Only displayed for R3D media, indicates whether or not it’s HDRX media.</td>
</tr>
<tr>
<td><strong>IDT:</strong></td>
<td>If ACES color science is selected in the Color Management panel of the Project Settings, the IDT used by that clip is listed here.</td>
</tr>
<tr>
<td><strong>In:</strong></td>
<td>The timecode value of the In point, if any, that’s stored for that clip.</td>
</tr>
<tr>
<td><strong>Input Color Space:</strong></td>
<td>If Resolve Color Management is selected in the “Color Science” menu of the Color Management panel of the Project Settings, then this column will show the Input Color Space that has been assigned to each clip. By default, all clips inherit the Input Color Space setting that’s been selected in the Color Management panel of the Project Settings.</td>
</tr>
<tr>
<td><strong>Input LUT:</strong></td>
<td>Which input Lookup table has been assigned, if any.</td>
</tr>
<tr>
<td><strong>Input Sizing Preset:</strong></td>
<td>The currently selected Input Format Preset, if there is one.</td>
</tr>
<tr>
<td><strong>Keyword:</strong></td>
<td>A user-editable field for entering searchable keywords pertaining to that clip. Only shows clip keywords, not marker keywords.</td>
</tr>
<tr>
<td><strong>Offline Reference:</strong></td>
<td>Lists the offline reference video that has been assigned to a given timeline.</td>
</tr>
<tr>
<td><strong>Optimized Media:</strong></td>
<td>Populated with the resolution of whatever optimized media you’ve created (Original, Half, Quarter, and so on). Clips that have not been optimized appear with “None.”</td>
</tr>
<tr>
<td><strong>Out:</strong></td>
<td>The timecode value of the Out point, if any, that’s stored for that clip.</td>
</tr>
<tr>
<td><strong>PAR:</strong></td>
<td>The pixel aspect ratio, if assigned.</td>
</tr>
<tr>
<td><strong>Reel Name:</strong></td>
<td>The reel name of that clip. Dynamically generated by the “Assist using reel names from the” setting in the General Options panel of the Project Settings.</td>
</tr>
<tr>
<td><strong>Resolution:</strong></td>
<td>The frame size of the media file.</td>
</tr>
<tr>
<td><strong>Roll/Card:</strong></td>
<td>An editable field to contain the roll number of media that was scanned from film.</td>
</tr>
<tr>
<td><strong>S3D Sync:</strong></td>
<td>Shows a frame count when you slip an eye to fix non-synced timecode using the “Slip Opposite Eye One Frame Left/Right” commands. This parameter is editable in the Media Pool.</td>
</tr>
<tr>
<td><strong>Sample Rate:</strong></td>
<td>The sample rate of the media file’s audio, if there is any.</td>
</tr>
<tr>
<td><strong>Scene:</strong></td>
<td>An editable field to contain the scene number of the media, relative to the script.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Shot</td>
<td>An editable field to contain the shot number of the media, relative to the scene.</td>
</tr>
<tr>
<td>Slate TC</td>
<td>The Slate timecode track used to sync audio with video.</td>
</tr>
<tr>
<td>Start</td>
<td>The first frame number of the media file.</td>
</tr>
<tr>
<td>Start KeyKode</td>
<td>The starting KeyKode value of a scanned negative.</td>
</tr>
<tr>
<td>Start TC</td>
<td>The timecode value of the first frame in the media file.</td>
</tr>
<tr>
<td>Take</td>
<td>An editable field to contain the take number of the media, relative to the shot.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of item, such as Video+Audio, Video, Audio, Timeline, Multicam, Still, and so on.</td>
</tr>
<tr>
<td>Usage</td>
<td>After a timeline has been created by importing an AAF, EDL, or XML project, the Usage column automatically reflects how many times each clip is used in the project. This makes it easy to identify clips that aren’t in use, and which can be removed from the Media Pool.</td>
</tr>
<tr>
<td>V-FLIP</td>
<td>Whether that media file is vertically flipped in DaVinci Resolve.</td>
</tr>
<tr>
<td>Video Codec</td>
<td>The specific codec used by the video portion of the media file.</td>
</tr>
</tbody>
</table>

**Editable Description and Comments Columns**

When the Description and Comments columns are displayed by the Media Pool in List view, you can edit their contents by clicking once within a clip’s Description or Comments field, waiting a moment, and then clicking a second time to select that field.

**Using Metadata View in the Media Pool**

In the Metadata View mode, each clip is represented by its own card with a thumbnail and basic clip metadata information visible. This view is designed to have more metadata information than a thumbnail but more targeted information than the List view. This feature, combined with its sort modes, is a powerful way to organize and reorganize your clips in the Media Pool.

**The metadata fields of the Metadata view (from the top down):**

- **Thumbnail**: A scrubbable thumbnail image of your clip.
- **Row 1**: A main description field that is variable and determined by the sort order selection.
- **Row 2**: Start Timecode, Date Created, Camera #.
- **Row 3**: Scene, Shot, Take.
- **Row 4**: Clip Name, Comment.

The strength of the Metadata view is the automatic clustering of your clips based on the sort order you choose in the Media Pool Sort By menu, at the very upper-right corner of the Media Pool.
Each different sort mode changes the main description field on the card, as well as re-arranging the Media Pool to reflect the selected organization method.

The sort modes available in the Metadata view are:

- **Bin**: This mode clusters the clips by bin, changes the main description field to clip name, and orders the list by timecode.

- **Timecode**: This mode clusters the clips by creation date, changes the main description field to creation date and start timecode, and orders the list by timecode.

- **Camera**: This mode clusters the clips by camera #, changes the main description field to camera # and start timecode, and orders the list by timecode.

- **Date Time**: This mode clusters the clips by day, changes the main description field to creation date and file name, and orders the list by timecode.

- **Clip Name**: This mode clusters the clips by the first letter of the clip name in alphabetical order, changes the main description field to clip name, and orders the list by timecode.

- **Scene, Shot**: This mode clusters the clips by scene, changes the main description field to scene-shot-take, and orders the list by scene-shot-take.

- **Clip Color**: This mode clusters the clips by clip color name, changes the main description field to creation date and start timecode, and orders the list by timecode.

- **Date Modified**: This mode clusters the clips by day, changes the main description field to creation date and file name, and orders the list by the last time the clip was modified by the OS filesystem.

- **Date Imported**: This mode clusters the clips by day, changes the main description field to creation date and file name, and orders the list by the date the clip was added to the Media Pool.

- **Ascending**: Orders the Media Pool from lowest numerical value to highest, and alphabetically from A to Z.

- **Descending**: Orders the Media Pool from highest numerical value to lowest, and alphabetically from Z to A.
Finding Clips, Timelines, and Media

There are several ways to locate different items in the Media Pool and Media Storage, be they clips, timelines, or media on disk.

Finding Clips and/or Timelines Within the Media Pool

Clicking the magnifying glass button at the upper right-hand corner of the Media Pool exposes the Search Options, which by default can be used to locate one or more clips in the currently selected bin or bins, based on the metadata that’s selected in the Filter By drop-down menu to the left of it.
A drop-down menu right next to the magnifying glass icon lets you choose the scope of your search. This lets you choose whether a search looks through all bins in the current project for the specified criteria, or just looks at the currently open bin, or currently selected bins in the Bin list, in cases where you’re looking for an instance of media in a specific hierarchical location of the Media Pool.

To find a clip in the Media Pool:

1. (Optional) Use the drop-down menu next to the Search button that exposes the Search and Filter by controls in the Media Pool to choose whether you select All Bins or Selected Bins.

2. (Optional) If you’re searching Selected Bins, then open the Bin list and select one or more bins in which to search.

3. (Optional) Choose a criteria from the Search Options drop-down menu at the top right of the Media Pool; you can choose All Fields to do a simultaneous search of every metadata column in the Media Pool at once, or you can choose a specific criteria to restrict your search.

4. Type a search term in the Search field. As soon as you start typing, all clips that don’t match the search criteria are temporarily hidden. To show all clips in the Media Pool again, click the cancel button at the right of the search field.

Finding Synced Audio

If you’ve synced dual-system audio and video clips together in DaVinci Resolve, you can find the audio clip that a video clip has been synced to using the following procedure.

To find the audio clip that a video clip has been synced to:

– Show the Media Pool in List view, and reference file name in the Synced Audio column.

– Right-click a video clip that’s been synced to audio, and choose “Reveal synced audio in Media Pool” from the contextual menu. The bin holding the synced audio clip is opened and that clip is selected.

Finding Timeline Clips in the Media Pool

If you have a clip in a timeline and you want to find the corresponding clip that it’s conformed to in the Media Pool, you can right-click that clip, and choose Find in Media Pool from the contextual menu.

Finding Timelines in the Media Pool

If you’d like to find the currently open timeline’s location in the Media Pool, you can choose Timeline > Find Current Timeline in Media Pool.

Finding Media in the Media Storage Panel and Finder

If you find yourself needing to determine the location of a clip’s source media file on disk, you can right-click an item in the Media Pool and choose Reveal in Media Storage panel. The Library automatically opens to the folder containing the media file you’ve selected, with that media file selected in the Library browser to the right.
Another feature that’s only available for macOS systems is the ability to right-click an item in the Media Pool and choose Reveal In Finder. A file system window opens up, revealing the media file that clip is linked to.

**Going Immediately to a File System Location in the Media Browser**

Conversely, if you drag a folder from the macOS Finder into the Media Storage panel, the Media Storage panel will immediately update to show the location of that folder.

**Tracking Media Usage**

As clips are added to timelines, two mechanisms come into play for keeping track of which clips are used in which timelines.

**Thumbnail Clip Usage Indicators**

Whenever you open a timeline, all thumbnails in the Media Pool automatically update to show highlighted usage bars to let you know which parts of that clip are used in that timeline.

If you right-click on a thumbnail that shows usage, a Usage submenu shows you a list of each instance of that clip in the currently open timeline. Choosing an instance from this list jumps the playhead to that clip in the Timeline.

**List View Clip Usage Column**

Exposing the Usage column when the Media Pool is in List view lets you see a value for the number of times a clip appears in all timelines of the current project. This usage column is now automatically updated; no user intervention is required.
NOTE: The usage column increments for each clip item that appears in the Timeline. This means that if a clip consists of one video item and one video item linked together, the usage column will show the number 2.

Relinking Media Simply

DaVinci Resolve keeps track of the relationship between clips in your project and their corresponding source media on disk. If, for whatever reason, source media that links to clips in your project becomes unavailable, DaVinci Resolve has several different methods of relinking those clips in the Media Pool.

This section summarizes the methods of relinking. For more comprehensive information on conforming projects and relinking media, see Chapter 57, “Conforming and Relinking Clips.”

Relink Media

If DaVinci Resolve fails to find your media, a Relink Media icon in the Cut and Edit page’s Media Pool will highlight orange.

Clicking this icon opens a dialog box showing the volumes that the missing files initially belonged to. You can then use this information to track down the media on your file system, find that specific hard drive, or ask a client if they provided you the media from this volume. Clicking the Locate button lets you re-connect the missing clips to a new file location of your choosing. If the quick search initiated by the Locate buttons doesn’t find media that you know is there, you can initialize an exhaustive deep disk search for the media by clicking on the Disk Search button.
Relink Selected Clips

The easiest method of relinking clips in your project that have gone offline is to use the appropriately named “Relink selected clips” command. This is the most flexible method of relinking clips in your project with clips in a file system directory of your choice, using file name and timecode as the primary criteria for drawing a correspondence between each clip and the corresponding media file on disk. When you relink clips this way, the original file path in DaVinci Resolve is ignored, so this is a good command to use to relink to media that’s been reorganized on disk.

To relink selected clips:

1. Do one of the following:
   - Select one or more clips in the Media Pool browser that you want to relink, then right-click one of the selected clips or the selected bin, and choose “Relink Selected Clips” from the contextual menu.
   - Select a bin in the Media Pool Bin list that contains clips you want to relink, then right-click one of the selected clips or the selected bin, and choose “Relink Clips for Selected Bin” from the contextual menu.

2. When the Relink File dialog opens, choose a directory in which to look for the files you want to relink to, and click OK. DaVinci Resolve attempts to find every clip with a matching file name in the subdirectories of the directory you chose, using the original file paths of the clips being relinked to do this as quickly as possible. By first looking for the clips in the directories they were originally in, relinking can be quite fast.

3. If there are any clips that couldn’t be found using the method in step 2, you’re prompted with the option to do a “deep search” by a second dialog. If you click Yes, then DaVinci Resolve will look for each clip inside every subdirectory of the directory you selected in step 2. This may take significantly longer, but it should be completely successful so long as the media that’s required is within the selected directory structure.

4. If there are still other clips that couldn’t be found, you’re prompted to either choose another directory altogether to continue searching, or quit.

Change Source Folder

If you’ve used your file system to move media that’s associated with a DaVinci Resolve project, but you haven’t changed the directory structure with which it’s organized, you can use the Change Source Folder command to quickly relink selected clips in the Media Pool to the new file path of the media on disk, using the original file paths as a guide. This is a good relinking method to use, if possible, for projects on a SAN where you don’t want to risk the excessively long search times that could result from using the Relink command to examine a nested hierarchy of folders in a more flexible way.

To relink your Media Pool clips to a new location:

1. Select one or more clips in the Media Pool, then right-click one of the selected clips, and choose Change Source Folder from the context menu. The Relink Media window appears displaying the original path for the material, with controls for choosing a new directory.

2. Click the “Browse” button to the right of the Change To field, and then use the file navigation dialog to find the new location of the media file, select it, and click Open.

3. If you succeeded in finding the appropriate media file, click Change. Otherwise, click Cancel.
Chapter 18

Using Clip Metadata

DaVinci Resolve has powerful tools for viewing, editing, exporting, and importing metadata associated with each clip in the Media Pool. Once your metadata house is in order, you can use this metadata in the Edit, Color, and Audio pages to find, sort, and organize the clips in your project, so you can work faster.

Contents

- Editing Clip Metadata
- Automatically Imported Metadata
- Using the Metadata Editor
- Editing Keywords
- Editing Metadata Using the File Inspector
- Face Detection to Generate People Keywords
- Creating Custom Metadata Groups
- Importing and Exporting Media Pool Metadata
- Different Ways of Using Clip Metadata
- Renaming Clips Using Clip Names
- Switching Between File Names and Clip Names
- Using Metadata to Define Clip Names
Editing Clip Metadata

Whether you’ve imported media in preparation for editing, or you’ve imported a project for grading that resulted in media being imported automatically, once you’ve added clips to the Media Pool, it would behoove you to consider taking the time to review and add metadata to your clips.

At the very least, it would be valuable for you to use the Metadata Editor that’s available in either the Media page or the Edit page to add information to each clip such as a Description, Shot and Scene designations, Take information, and possibly some useful keywords such as Character Names, Shot Framing, Interior or Exterior keywords, and so on. If you’re especially ambitious (or you have a very responsible assistant), you could go further and add Shoot Day, Camera Type, Audio Notes, and other valuable information. Much of the metadata that is useful in the day to day work of editing and grading can be found in the Shot & Scene group, but there are many other potentially useful groups as well that you should explore.

Keep in mind that the more metadata you associate with each clip, the more methods you have at your disposal for creating custom Smart Bins (for editing) and Smart Filters (for grading) with which to zero in on the clips you need for any given situation. This will not only make it easier to find what you need, but it’ll help you to work faster.

For example, if you’ve entered enough metadata, then you can create multi-criteria Smart Bins or Smart Filters that let you find the equivalent of “every close-up of Sally inside the diner,” or “every long shot of Antonio outside in the parking lot.” In a documentary, you could easily isolate “every interview shot of Louis from camera 1,” or “every B-roll clip with Robyn.” All of this will help you to find media faster for editing, or to quickly isolate similar clips that you need to match together for grading.

Automatically Imported Metadata

In many instances, metadata is also imported along with the media you’ve added to the Media Pool. For example, media recorded on BMD cameras may have had a variety of metadata entered into the camera or automatically generated by the camera, and this metadata is automatically available in the Metadata Editor. Similarly, Broadcast WAVE files can have quite a bit of metadata entered at the time of recording, such as scene and take numbers and channel names describing each microphone. Still images are imported with EXIF metadata. In all cases, available metadata is imported along with the media and exposed in the Metadata Editor to facilitate workflows where valuable organizational metadata is being entered on set during the shoot or immediately after ingest.

Using the Metadata Editor

Whenever you select a clip in the Media Pool, its editable metadata appears in the appropriately named Metadata Editor (so long as it’s displayed). You can use this editor to further massage the metadata of the clips in a project, adding information on set that will be of help later during editing and finishing.

By default, clips initially appear with a set of clip metadata called “Clip Details,” that shows some of the most fundamental details of the clip such as start and end timecode, duration, bit depth, and so on.

Because there are so very many metadata fields that are available, two drop-down menus at the top right of the Metadata Editor let you change which set of metadata is displayed.

– Metadata Presets (to the left): If you’ve used the Metadata panel of the User Preferences to create your own custom sets of metadata, you can use this drop-down to choose which one to expose. Surprisingly enough, this is set to “Default” by default.

– Metadata Groups (to the right): This drop-down menu lets you switch among the various groups of metadata that are available, grouped for specific tasks or workflows.
If you want to see a list of every piece of metadata in a clip, you can choose All Groups. Otherwise, you can choose any set of metadata to narrow your focus to just those items of information.

**To edit metadata for a single clip:**
Select any clip in the Media Pool, and edit whatever metadata fields you require. The edited metadata is immediately saved.

**To edit metadata for multiple clips:**
1. Choose a metadata set using the drop-down menu in the Metadata Editor.
2. Select multiple clips in the Media Pool by Shift-clicking, Command-clicking, or dragging a bounding box around them.
3. Edit whichever metadata fields you want to. Checkboxes are automatically turned on for any metadata fields you edit.
4. When you’re done, click the Save button at the bottom of the Metadata Editor. When you’ve edited metadata for multiple clips at once, you’ll be prompted to save your changes if you create a new selection in the Media Pool without clicking the Save button first.

**Editing Keywords**
While most metadata in the Metadata Editor is edited via text fields, checkboxes, or multiple button selections (such as Flags and Clip Color), the Keyword field is unique in that it uses a graphical "tag" based method of data entry. The purpose of this is to facilitate consistency with keyword spelling by making it easy to reference both a built-in list of standardized keywords, as well as other keywords that you’ve already entered to other clips.

Once added, keywords are incredibly useful for facilitating searching and sorting in the Media Pool, for creating Smart Bins in the Media and Edit pages, and for use in Smart Filters on the Color page. Reaping these benefits by adding and editing keywords is simple, and works similarly to the method of entering metadata variables. For more information on metadata variables, see Chapter 15, “Using Variables and Keywords.”
To add a keyword:

1. Select the Keyword field of the Metadata Editor, and begin typing the keyword you want to use. As you begin typing, a scrolling list appears showing all keywords that are available using the string of characters you've just typed.

2. To find a specific keyword in the list, start typing that keyword's name and this list automatically filters itself to show only keywords that contain the characters you’ve just typed. Choose which keyword you want to use in the list using the Up and Down Arrow keys, and press Return to choose that keyword to add.

As soon as you add one or more keywords, they appear as a graphical tag. To re-edit any keyword, simply click anywhere within the Keyword field to edit it.

To edit a keyword:

- Double-click any keyword to make it editable, then edit it as you would any other piece of text, and press Return to make it a graphical keyword tag again.

To remove a keyword:

- Click any keyword to select it, and press Delete.

Editing Metadata Using the File Inspector

The File tab of the Inspector provides a consolidated way to view and edit a subsection of a clip’s most commonly used media file metadata. It’s easily accessible in the Inspector across the Media, Cut, Edit, and Fairlight pages. The tab is composed of the following parts:

- **Clip Details**: Presents data about the clip’s data format (codec, resolution, frame rate, etc.).
- **Metadata**: Presents a reduced set of common metadata fields for quick user entry.
  - **Timecode**: The start timecode of the clip. This field is editable if you want to manually change the clip’s starting timecode.
  - **Date Created**: The date that the clip was created. This field is editable if you want to manually change the clip’s creation date.
  - **Camera**: Sets the Camera # metadata.
  - **Reel**: Sets the Reel/Card ID.
  - **Scene**: The Scene number of the clip.
  - **Shot**: The Shot letter/number of the clip.
  - **Take**: The Take number of the clip.
  - **Good Take**: This checkbox indicates if the clip is a good or circled take.
  - **Clip Color**: Assign a specific color to a clip that is reflected in the Timeline.
  - **Name**: The clip name field; this can be entered manually.
– **Comments**: Add a text description to the clip.

– **Auto Select Next Unsorted Clip**: When this box is checked, the next clip in the Media Pool is selected when you hit the return button after entering a metadata field, and the cursor is automatically placed in the same field. This allows rapid sequential metadata entry without having to manually click to load each individual clip in the Media Pool. The Next Clip button will select the next clip in the Media Pool, regardless of the checkbox status.

The File Inspector parameters

**Tips for Editing Metadata**

Editing metadata is like taking vitamins. Nobody wants to, but you know you probably should. To encourage you to undertake this task so you can reap the benefits, here are a few pointers.

– Don’t start editing until you review your footage and add metadata. If you get into the habit of entering your clip metadata before you get preoccupied with your edit, you’ll be in a much better position to edit faster using organizational tools that leverage the metadata you’ve entered.

– Enter metadata starting with groups of clips and then moving to individual clips. Since the Metadata Editor lets you add metadata for multiple selected clips at once, it becomes easy to select groups of clips based on their thumbnails for entering information such as Scene designations, Interior or Exterior keywords, Character keywords, and Framing keywords. You’ll be surprised how fast this goes, and how useful this information is later on, for both editing and grading.

– After you’ve entered all the metadata you can in groups of clips, then switch to entering clip-specific metadata such as Shot designations, Take numbers, descriptions of action, and other clip-specific keywords.

– There’s no right or wrong way to edit or use metadata, but a lack of consistency will make it less useful. For example, if you’re identifying each clip that takes place at the same diner, try to use the same keyword or descriptive text. If you call half the shots “diner” and the other half “restaurant,” your ability to easily search for all the diner shots will be compromised.
Face Detection to Generate People Keywords

You can select multiple clips in the Media Pool, then right-click the selection and choose “Analyze clips for people” from the contextual menu to automatically analyze all selected clips using the DaVinci Neural Engine, identifying faces that can be used to help organize the media. A progress dialog shows you how long until the analysis is finished (you can cancel the operation if necessary).

Afterwards, the People Management window appears that shows you the results, automatically organized into a number of bins in a sidebar.

- A “People” bin shows each face that has been recognized as an individual person. Click, pause, then click again underneath any thumbnail to edit the name or role of that person. You must assign a name if you want a keyword to appear for that individual in the People field of the Metadata Editor. Assigning names renames the bins corresponding to each found person and enables retagging to fix mistaken identification.

![](image1.png)

The Face Recognition window seen immediately after a Face Recognition operation

- Individual bins collect all clips with a particular person, allowing you to evaluate whether or not the contents have been identified correctly. If you see an incorrectly identified clip, you can right-click it and re-tag it from the contextual menu, or choose “Untag” if it’s a new person that has not been identified at all.

![](image2.png)

A bin for a particular person lets you evaluate the contents
An “Other People” bin shows all faces that could not be identified. You can right-click any of these to re-tag it as one of the people that have been already identified, or you can choose New Person if it’s someone who wasn’t initially identified (this sometimes happens when multiple people have very similar features).

The Face Recognition window seen immediately after a Face Recognition operation

Clicking the Close button closes this window and assigns the names you edited as keywords to the People field of the “Shot & Scene” group in the Metadata Editor. Clips with multiple people who have been identified have multiple keywords assigned.

The People keywords field of the Shot & Scene group in the Metadata Editor, populated with who is in that shot

Once People keywords are assigned to one or more clips, a People smart category of smart bins can automatically be created in the Smart Bins sidebar of the Media Pool, making it easy to immediately begin finding clips that have specific people in them. To create this People Smart Bin, select “Automatic Smart Bins for People Metadata” box in the Preferences > User > Editing window.

You can reopen the Face Recognition window at any time to make modifications by choosing Workspace > People. You can reset all faces by clicking the People Management Option menu and choosing “Reset Face Database.”

**NOTE:** A command in the Option menu of the Face Recognition window, Reset Face Database, lets you reset all analyzed results if the results are not acceptable and you don’t want to save the resulting metadata.
Creating Custom Metadata Groups

The Metadata panel in the User Preferences lets you create custom sets of metadata parameters that will be exposed in the Metadata Editor. Using this panel, you can create customized subsets of metadata that are focused on your particular needs.

Presets that you create are available from the Option menu that’s just to the left of the Metadata categories drop-down menu.

Choose any custom preset to restrict the Metadata Editor to only showing the metadata fields in that preset. To see the full set of custom metadata fields you’ve saved to a particular preset, you should set the Metadata Categories drop-down menu to All Groups. To make the full set of metadata fields reappear, just choose default presets in the same drop-down.

Making and managing metadata presets is simple.

**To create a new metadata preset:**
1. Open the Metadata panel of the User pane of the Preferences window, and click New.
2. Click the checkboxes of every metadata tag you want to include in this preset, or click the checkbox of a group name on the list to include all metadata tags within it.
   
   Every single metadata tag available in DaVinci Resolve appears within one of several groups that appear as a list. To open any group to see its contents, move the pointer over that group’s entry on the list, and click the Open button when it appears.
3. When you’re finished, click the Save button under Metadata Options.
4. Click the Save Button for the User Preferences.

**To edit an existing metadata preset:**
1. Select a preset from the list, and click Edit.
2. Turn checkboxes on and off to include or exclude whatever tags you need.
3. Click the Save button under Metadata Options.
4. Click the Save Button for the User Preferences.

**To delete a metadata preset:**
Select a preset from the list and click Delete.
Importing and Exporting Media Pool Metadata

Once you’ve taken the trouble to add metadata to the clips in your project, DaVinci Resolve makes it possible to export metadata from the Media Pool of one project for import into the clips of another project, for instances where you need to move metadata around.

For example, a DIT might have entered a lot of metadata to the DaVinci Resolve project used for generating dailies, but then an impatient editor might have created a separate project to begin editing those dailies. Instead of requiring the editor to enter each clip’s metadata all over again, you can export the metadata from the DIT’s project and import it into the editor’s new project, automatically matching the relevant metadata to each corresponding clip.

To export Media Pool metadata:

1. Open a project containing Media Pool metadata you want to export.
2. Optionally, select which clips in the Media Pool you want to export metadata for.
3. Choose File > Export Metadata From > Media Pool to export metadata from every clip in the Media Pool, or choose File > Export Metadata From > Selected Clips to only export metadata from clips you selected in step 2.
4. When the Export Metadata dialog appears, enter a name and choose a location for the file to be written, then click Save. All metadata is exported into a .csv file that can be viewed and/or edited in any spreadsheet application.

If you open the resulting metadata .csv file, the first line is a header that lists what metadata is to be found for each item listed in this document, and in what order. Only metadata fields that have been populated for at least one clip are exported and listed in this header; unused metadata fields in the Metadata Editor or Media Pool are ignored.

This file can now be imported into another project file to reattach the metadata to the same clips.

To import Media Pool metadata:

1. Open a project containing clips you want to populate with imported metadata.
2. Optionally, select which clips in the Media Pool you want to import metadata to.
3. Choose File > Import Metadata To > Media Pool to import metadata to potentially every clip in the Media Pool, or choose File > Import Metadata To > Selected Clips to only import metadata to clips you selected in step 2.
4. When the Import Metadata dialog appears, choose a metadata .csv file to import, and click Open.
5. When the Metadata Import dialog appears, choose the Import Options you want to use to match the .csv file's metadata to the correct clips in the currently open project. By default, DaVinci Resolve tries to use “Match using filename” and “Match using clip start and end Timecode” to match each line of metadata in the .csv file with a clip in the Media Pool, but there are other options you can use such as ignoring file extensions, using Reel Name, and using source file paths.
6. Next, choose which Merge Option you want to use in the Metadata Import dialog. There are three options:
   - **Only update metadata items with entries in the source file**: The default setting. Only updates a clip’s metadata if there’s a valid entry in the imported .csv file. Other clip metadata fields are left as they were before the import.
   - **Update all metadata fields available in the source file**: For each clip that corresponds to a line of metadata in the imported .csv file, every single metadata field referenced by the .csv file is overwritten, regardless of whether or not there’s a valid entry for that field.
– **Update all metadata fields available in the source file and clear others:** For each clip that corresponds to a line of metadata in the imported .csv file, every single metadata field referenced by the .csv file is overwritten, regardless of whether or not there’s a valid entry for that field. Furthermore, metadata fields that aren’t referenced by the imported .csv file are cleared of whatever metadata was there before.

The Metadata Import dialog that lets you choose options for how to match and merge imported metadata

When you’re finished choosing options, click Ok and all available metadata from the source .csv file will be imported.

### Different Ways of Using Clip Metadata

To encourage you to take advantage of the clip metadata tools that exist in DaVinci Resolve, here’s a short list of the many different ways you can use clip metadata to help you work faster.

– Searching for clips in the Media Pool
– Searching for clips in the Timeline
– Sorting the Media Pool by metadata columns in list view
– Creating Smart Bins in the Edit page
– Creating Timeline Filters in the Color page
– Using Metadata to create clip Clip Names
– Displaying Metadata in frame using the Color page Burn In palette

### Renaming Clips Using Clip Names

The most fundamental piece of clip metadata is each clip’s name, which is used to identify clips nearly everywhere they appear inside DaVinci Resolve. By default, clips show the file name of the corresponding media file on disk. Since the dawn of tapeless recording, however, editors have been stuck with camera original media having names that are not exactly “human readable.”
Fortunately, you have the option of entering a more user-friendly clip name to use instead, while preserving the original file name that’s critical for maintaining the link between a clip and its media, as well as for tracking an offline clip’s corresponding link to the online media from which it originated. There are a few ways you can edit the clip name of a clip.

**NOTE:** You can also edit the clip names of timelines, compound clips, and multicam clips, so that you can have two sets of naming conventions for these items, one for when you’re doing creative editing, and one for when you’re doing finishing tasks.

**To edit a clip’s clip name, do one of the following:**

– In the Media Pool’s Icon view, click a clip’s name once, pause a moment, then click a second time to select the name, type a new name, then press return to accept the name.

– In the Media Pool’s List view, the Clip Name mirrors the source clip’s file name (hidden by default), but you can click the Clip Name column for any clip to add a new name from scratch.

– With the Clip Name column exposed in the Media Pool’s List view, Option-click the Clip Name column for any clip to edit the file name, rather than entering a brand new name.

– To edit the clip name of multiple clips, select all of the clips for which you want to change the clip name, then right-click one of the selected clips and choose Clip Attributes. Open the Name panel of the Clip Attributes window, edit the Clip Name field, and click OK.

After you’ve changed a clip’s clip name, that clip appears in the following places using the clip name instead of the original file name:

– The Media Pool’s Thumbnail view

– The name bar of each clip in the Timeline

– The Source Viewer title bar

– The Clip Name field of the Clip Attributes dialog’s Name panel

### Switching Between File Names and Clip Names

Since different tasks require different information, you have the ability to switch between using clip file names and clip names. For example, finishing editors will probably have more reason to refer to the file name of each clip, making it easier to troubleshoot problems with reconforming and relinking. Creative editors, on the other hand, will want to use easier-to-read clip names to make it easier to find what they need.

**To switch between file names and clip names:**

– Choose View > Show File Names to toggle between both naming conventions.

### Using Metadata to Define Clip Names

If you’re an enthusiastic user of clip metadata (and you should be), you can use “metadata variables” that you can add into a field that let you reference other metadata for that clip. For example, you could add the combination of variables and text seen in the following screenshot to define a clip name automatically. Variables, once they’ve been entered, are represented as graphical tags shown with a background, while regular text characters that you enter appear before and after these tags.

![Variables and text characters entered to create a clip name based on a clip’s metadata](image)
As a result, that clip would display "12_A_3" as its name if scene "12," shot "A," and take "3" were its metadata. When you do this, you can freely mix metadata variables with other characters (the underscore, as in the example above) to help format the metadata to make it even more readable.

Every single item of metadata that’s available in the Metadata Editor can be used as a variable, and several other clip and timeline properties such as the version name of a clip’s grade, a clip’s EDL event number, and that clip’s timeline index number can be also referenced via variables.

Since the use of metadata variables is a great way to automatically generate names for multiple clips, you may find it more useful to add metadata variable-driven clip names by selecting all of the clips you want to edit, and opening the Clip Attributes window. By editing the Clip Name field found in the Name panel, you can add a single clip name to all selected clips at once.

To add a variable to a text field that supports the use of variables:

1. Type the percentage sign (%) and a scrolling list appears showing all variables that are available.
2. To find a specific variable quickly, start typing the characters of that variable’s name and this list automatically filters itself to show only variables that contain the characters you’ve just typed.
3. Choose which variable you want to use using the Up and Down Arrow keys, and press Return to choose that variable to add.

As soon as you add one or more metadata variables to a clip's Clip Name column and press Return, the string is replaced by its corresponding text. To re-edit the metadata string, simply click within that column, and the metadata variables will reappear. Be aware that, for clips where a referenced metadata field is blank, no characters appear for that corresponding metadata variable in the Clip Name column.

To remove a metadata variable:

– Click within a field using variables to begin editing it, click a variable to select it, and press Delete.

For more information on the use of variables, as well as a list of all variables that are available in DaVinci Resolve, see Chapter 15, “Using Variables and Keywords.”
Chapter 19

Using the Inspector in the Media Page

The Inspector holds all the controls to modify, resize, retime, and generally adjust anything related to a clip, transition, or effect on the Media page Timeline.

Contents

Using the Inspector 353
Adjusting Media Pool Clips in the Inspector 353
Video 354
Audio 357
Image 358
File 359
Using the Inspector

The Inspector has been redesigned to make it easier to find specific controls and to adjust common settings for your clips. Instead of a long vertical list, different aspects of the Inspector have now been organized into panels, with each controlling specific grouped sets of parameters for your clip.

The Inspector is activated by clicking on the Inspector Panel in the upper-right section of the User Interface toolbar. The Inspector is broken up into individual Video, Audio, Effects, Transition, Image, and File panels. Inspector panels that are not applicable to your clip or selection are grayed out.

![Inspector Panel icon in the upper right of the UI toolbar](image)

![The Inspector panels showing Video, Audio, and File parameters available for adjustment; others are grayed out.](image)

Methods of using controls in the Inspector:

- **To activate or deactivate a control**: Click the toggle to the left of the control's name. The orange dot on the right means the control is activated. A gray dot on the left means the control is deactivated.
- **To reveal a control's parameters**: Double-click the control's name.
- **To reset controls to their defaults**: Click the reset button to the right of the control's name.

Adjusting Media Pool Clips in the Inspector

You can directly modify Media Pool clips in the Inspector, before you edit those clips into a timeline. This allows you to change the parameters of source media so that clips that are subsequently edited into a timeline carry those new settings with it. For example, you can prepare your material prior to editing by changing the clip's file and RAW settings, adjusting the audio levels and EQ, or assigning it a specific lens correction, etc. Once modified, any part of that clip would have the correct Inspector parameters already in place when you edited them into your timeline.

**To adjust Media Pool clips in the Inspector:**

1. Select one or more clips in the Media Pool Panel of either the Media, Cut, Edit, or Fairlight pages.
2. Open the Inspector panel, and adjust any parameters in the Video, Audio, Image and File tabs.

These parameter changes are stored with the Media Pool clip, and will be carried over when any part of that clip is edited into the Timeline. Of course, each clip's Inspector parameters can be further modified once it's in the Timeline, and those Timeline parameters are independent from the Media Pool Inspector settings. This means that any further adjustments you make to the clip in the Timeline do not affect that same clip's adjustments already in the Media Pool.
Video

The Video Panel of the Inspector exposes a vast array of controls designed to manipulate the size, speed, and opacity of your clips.

Transform

The Transform section of the Video Inspector panel

The Transform group includes the following parameters for resizing and repositioning your clips:

- **Zoom X and Y**: Allows you to blow the image up or shrink it down. The X and Y parameters can be linked to lock the aspect ratio of the image, or released to stretch or squeeze the image in one direction only.
- **Position X and Y**: Moves the image within the frame, allowing pan and scan adjustments to be made. X moves the image left or right, and Y moves the image up or down.
- **Rotation Angle**: Rotates the image around the anchor point.
- **Anchor Point X and Y**: Defines the coordinate on that clip about which all transforms are centered.
- **Pitch**: Rotates the image toward or away from the camera along an axis running through the center of the image, from left to right. Positive values push the top of the image away and bring the bottom of the image forward. Negative values bring the top of the image forward and push the bottom of the image away. Higher values stretch the image more extremely.
- **Yaw**: Rotates the image toward or away from the camera along an axis running through the center of the image from top to bottom. Positive values bring the left of the image forward and push the right of the image away. Negative values push the left of the image away and push the right of the image forward. Higher values stretch the image more extremely.
- **Flip Image**: Two buttons let you flip the image in different dimensions.
  - **Flip Horizontal control**: Reverses the image along the X-axis, left to right.
  - **Flip Vertical control**: Reverses the clip along the Y-axis, turning it upside down.

Cropping

The Cropping section of the Video Inspector panel
The Video Inspector controls the image’s cropping parameters:

- **Crop Left, Right, Top, and Bottom**: Lets you cut off, in pixels, the four sides of the image. Cropping a clip creates transparency so that whatever is underneath shows through.

- **Softness**: Lets you blur the edges of a crop. Setting this to a negative value softens the edges inside of the crop box, while setting this to a positive value softens the edges outside of the crop box.

- **Retain Image Position**: Clicking this checkbox will lock the crop parameters in place when you resize the image using the Transform tool above. Unchecking this box will scale and position the crop as well as the image.

### Dynamic Zoom

The Smart Reframe section of the Video Inspector panel

The Dynamic Zoom controls, which are off by default, make it fast and easy to do pan and scan effects to zoom into or out of a clip. Turning the Dynamic Zoom group on activates two controls in the Inspector that work hand-in-hand with the Dynamic Zoom onscreen adjustment controls. For more information on using the Dynamic Zoom controls, see Chapter 51, “Compositing and Transforms in the Timeline.”

- **Dynamic Zoom Ease**: Lets you choose how the motion created by these controls accelerates. You can choose from Linear, Ease In, Ease Out, and Ease In and Out.

- **Swap**: This button reverses the start and end transforms that create the dynamic zoom effect.

### Composite

The Composite section of the Video Inspector panel

Composite modes can be used to combine clips that are superimposed over other clips in the Timeline.

- **Composite Mode**: This selects the type of composite mode to combine the superimposed clips. The default “Normal” means no compositing mode is applied. For more information on Composite Modes, see Chapter 51, “Compositing and Transforms in the Timeline.”

- **Opacity**: This slider makes a clip more or less transparent in addition to compositing already being done.

### Lens Correction

The Lens Correction section of the Video Inspector panel
The Lens Correction group (only available in Resolve Studio) has two controls that let you correct for lens distortion in the image, or add lens distortion of your own.

- **Analyze**: Automatically analyzes the frame in the Timeline at the position of the playhead for edges that are being distorted by wide angle lens. Clicking the Analyze button moves the Distortion slider to provide an automatic correction. If you’re analyzing a particularly challenging clip, a progress bar will appear to let you know how long this will take.

- **Distortion**: Dragging this slider to the right lets you manually apply a warp to the image that lets you straighten the bent areas of the picture that can be caused by wide angle lenses. If you clicked the Analyze button and the result was an overcorrection, then dragging this slider to the left lets you back off of the automatic adjustment until the image looks correct.

### Retime and Scaling

The Retime and Scaling section of the Video Inspector panel contains four parameters that affect retiming quality and clip scale:

- **Retime Process**: Lets you choose a default method of processing clips in mixed frame rate timelines and those with speed effects (fast forward or slow motion) applied to them, on a clip-by-clip basis. The default setting is “Project Settings,” so all speed-effected clips are treated the same way. There are three options: Nearest, Frame Blend, and Optical Flow, which are explained in more detail in the Speed Effect Processing section of Chapter 52, “Speed Effects.”

- **Motion estimation mode**: When using Optical Flow to process speed change effects or clips with a different frame rate than that of the Timeline, the Motion Estimation pop-up lets you choose the best-looking rendering option for a particular clip. Each method has different artifacts, and the highest quality option isn’t always the best choice for a particular clip. The default setting is “Project Settings,” so all speed-effected clips are treated the same way. There are several options. The “Standard Faster” and “Standard Better” settings are the same options that have been available in previous versions of DaVinci Resolve. They’re more processor efficient and yield good quality that are suitable for most situations. However, “Enhanced Faster” and “Enhanced Better” should yield superior results in nearly every case where the standard options exhibit artifacts, at the expense of being more computationally intensive, and thus slower on most systems. The Speed Warp setting is available for even higher-quality slow motion effects using the DaVinci Neural Engine. Your results with this setting will vary according to the content of the clip, but in ideal circumstances this will yield higher visual quality with fewer artifacts than even the Enhanced Better setting.

- **Scaling**: Lets you choose how clips that don’t match the current project resolution are handled on a clip-by-clip basis. The default setting is “Project Settings,” so that all mismatched clips use the same method of being automatically resized. However, you can also choose an individual method of automatic scaling for any clip. The options are Crop, Fit, Fill, and Stretch; for more information see the 2D Transforms section of Chapter 150, “Sizing and Image Stabilization.”

- **Resize Filter**: For clips that are being resized in any way, this setting lets you choose the filter method used to interpolate image pixels when resizing clips. Different settings work better for different kinds of resizing. There are four options:
  - **Sharper**: Usually provides the best quality in projects using clips that must be scaled up to fill a larger frame size, or scaled down to HD resolutions.
– **Smother**: May provide higher quality for projects using clips that must be scaled down to fit an SD resolution frame size.

– **Bicubic**: While the Sharper and Smoother options are slightly higher quality, Bicubic is still an exceptionally good resizing filter and is less processor intensive than either of those options.

– **Bilinear**: A lower quality setting that is less processor intensive. Useful for previewing your work on a low-performance computer before rendering, when you can switch to one of the higher quality options.

– **Other Resize Methods**: A selection of specific resize algorithms is available if you need to match them to other VFX workflows.

## Audio

The Audio tab contains four commonly used audio controls for video editing purposes, including Clip Volume, Clip Pan, Clip Pitch, and Clip Equalizer.

– **Clip Volume**: Each clip has a single volume control that corresponds to the volume overlay over each audio clip.

– **Clip Pan**: (Only exposed for clips) A simple Pan slider that controls stereo panning.
– **Clip Pitch**: Lets you alter the pitch of a clip without changing the speed. Two sliders let you adjust clip pitch in semi tones (large adjustments, a twelfth of an octave) and cents (fine adjustments, 100th of an octave).

– **Clip Equalizer**: Each clip also has a four-band EQ, complete with low-pass, high-pass, and parametric settings for fine tuning and problem-solving audio issues at the clip level.

**NOTE**: There are many more refined plug-ins and effects for audio clips in the Audio FX library. If you apply any of these, the controls will appear in the Inspector’s Effects tab Audio section, instead of here.

### Image

The Image panel contains groups of parameters that correspond to every camera raw media format that’s supported by DaVinci Resolve. Using these parameters in the Image panel, you can override the original camera metadata that was written at the time of recording and make simultaneous adjustments to camera raw media throughout your project.

For a detailed explanation of each of the RAW camera parameters supported by DaVinci Resolve, see Chapter 6, “Camera Raw Settings.”
The File panel of the Inspector provides a consolidated way to view and edit a subsection of a clip’s most commonly used media file metadata. It’s easily accessible in the Inspector across the Media, Cut, Edit, and Fairlight pages. The tab is composed of the following parts:

- **Clip Details**: Presents data about the clip’s data format (codec, resolution, frame rate, etc.).
- **Metadata**: Presents a reduced set of common metadata fields for quick user entry.
  - **Timecode**: The start timecode of the clip. This field is editable if you want to manually change the clip’s starting timecode.
  - **Date Created**: The date that the clip was created. This field is editable if you want to manually change the clip’s creation date.
  - **Camera**: Sets the Camera # metadata.
  - **Reel**: Sets the Reel/Card ID.
  - **Scene**: The Scene number of the clip.
  - **Shot**: The Shot letter/number of the clip.
  - **Take**: The Take number of the clip.
  - **Good Take**: This checkbox indicates if the clip is a good or circled take.
  - **Clip Color**: Assign a specific color to a clip that is reflected in the Timeline.
  - **Name**: This can be entered manually, and changes the Clip Name field across the entire project.
  - **Comments**: Add a text description to the clip.
- **Auto Select Next Unsorted Clip**: When this box is checked, the next clip in the Media Pool is selected when you hit the Return button after entering a metadata field, and the cursor is automatically placed in the same field. This allows rapid sequential metadata entry without having to manually click to load each individual clip in the Media Pool. The Next Clip button will select the next clip in the Media Pool, regardless of the checkbox status.
Chapter 20

Syncing Audio and Video

When you're working on a program where the production audio was recorded separately from the production video (often referred to as "dual-system recording), DaVinci Resolve provides tools for syncing the audio and video together in a variety of ways to create media that you can edit easily. The process of syncing audio and video together is often referred to as “ syncing dailies.”

Contents

Syncing Audio to Video 361
Syncing Audio to Video Using Timecode 361
Syncing Audio to Video by Matching Waveforms 362
Manually Syncing Audio to Video 363
Offsetting the Sync of Previously Synced Clips 364
Finding Synced Audio Files 364
Displaying Synced Audio File Names on the Timeline 365
Syncing Audio to Video

If you’re processing dailies for a shoot that used dual-system recording, where audio is recorded to a separate device than video, you can “sync the dailies” in DaVinci Resolve in one of two ways. Synced clips can be output as media files with embedded audio or output to tape, whatever your client requires.

Syncing Audio to Video Using Timecode

Ideally, if the sound recordist on set was highly organized, and the camera and audio recorder both used synchronized timecode, you can use a single command to automatically sync every clip in a timeline to a bin of Broadcast .wav files that have matching timecode.

To batch sync audio to video using timecode:

1. Create a new project, open to the Media page by default, and import the video media you need to sync into any bin of the Media Pool.

2. Import the matching Broadcast .wav files into the same bin as the accompanying video media you imported in Step 1. If you want to stay more organized, you can create another bin to contain the audio clips, but it must be inside the bin that contains the video files. The audio bin can be named anything you like.

3. Right-click the bin containing the matching audio and video clips, and choose one of the following commands from the contextual menu:
   - **Auto-Sync Audio Based on Timecode**: Replaces each video clip’s previous audio channels with audio channels from the newly synced .wav files.
   - **Auto-Sync Audio Based on Timecode and Append Tracks**: Adds new channels in addition to the audio channels that were previously in the media file. The newly synced channels are added to an additional track, so when edited into the Timeline, a clip that’s synced this way appears with one video clip and two audio clips that occupy two different audio tracks, so you can edit the camera original audio independently from the synced audio.

Every clip in the selected bin for which there was an accompanying Broadcast .wav file with matching timecode is immediately synced with an audio track. All synced clips appear with an audio icon at the bottom left in the Media Pool when Thumbnail view is selected. Now that the clips are synced, you can edit them in the Edit page or use the Deliver page to export offline dailies or online media with embedded sync audio for use in other applications.
Syncing Audio to Video by Matching Waveforms

If you don’t have matching timecode in the audio and video source clips you’re syncing, but you had the foresight to record camera audio at the same time as the dual source production audio you want to sync to, DaVinci Resolve can use waveform syncing to compare the audio waveforms of your audio and video source files, and sync the ones that match.

To batch sync dailies using waveform syncing:

1. Create a new project, open to the Media page by default, and import both the video and audio media you need to sync. There’s no need to organize your files in any particular way, but it’s not a bad idea, on multi-day shoots, to organize the audio and video files so that it’s easy to select all of a single day’s clips at once so that you can sync your files in smaller batches. Even organizing your clips by scene can make waveform syncing go faster by reducing the number of files that need to be compared at once.

2. If you’ve placed the audio and video into separate bins, then you can Command-click both bins in the bin list to select them and expose all of their contents in the Media Pool. If you placed your media in the same bin, this is not necessary.

3. Select one of the exposed clips in the Media Pool, and press Command-A to select all audio and video clips you want to sync.

4. Right-click one of the selected clips, choose Auto Sync Audio from the contextual menu, and select one of the methods below.

   - **Based on Timecode:** Synchronizes the timecode between the audio and video clips, and replaces each video clip’s previous audio channels with the newly synced .wav files.

   - **Based on Timecode and Append Tracks:** Synchronizes the timecode between the audio and video clips, and adds new channels in addition to the audio channels that were previously in the media file. The newly waveform-synced channels are added to an additional track, so when edited into the Timeline, a clip that’s synced this way appears with one video clip and two audio clips that occupy two different audio tracks, so you can edit the camera original audio independently from the synced audio.

   - **Based on Waveform:** Analyzes and compares the waveforms of each of the selected clips, and replaces each video clip’s previous audio channels with the newly synced .wav files.

   - **Based on Waveform and Append Tracks:** Analyzes and compares the waveforms of each of the selected clips, and adds new channels in addition to the audio channels that were previously in the media file. The newly waveform-synced channels are added to an additional track, so when edited into the Timeline, a clip that’s synced this way appears with one video clip and two audio clips that occupy two different audio tracks, so you can edit the camera original audio independently from the synced audio.

A progress bar dialog appears, showing you how long the syncing operation will take. When it’s complete, your clips will be synced.
Manually Syncing Audio to Video

If you have a collection of WAV or AIFF audio files with video source media that lacks matching timecode, you need to manually sync each pair of media files together, one-by-one, using a sync reference such as the clap of a clapperboard or any other sharp sound with a distinct audio/visual correspondence.

To manually sync audio to video:

1. Create a new project, and import the video media you need to sync into the Media Pool. If a dialog appears asking whether or not you want to update the project to match the media, click OK.

2. If you want to stay organized, create a second bin in the Media Pool, named Audio Clips, and import the matching Broadcast .wav files into it. The name of the bin is not important, and having all the audio in one bin is simply a matter of convenience.

3. Click the Waveform button at the top of the Audio Panel, which lets you view and scrub along the waveform of audio clips you select in the Media Pool.

4. Select a video clip to sync, and move the Viewer playhead to line up with the first visual sync point in the first clip. This could be the clap of a clapperboard, the red flash of a tablet computer’s slate app, a hand clap, or any clear visual cue to which there is a corresponding audible sound.

5. Now, select whichever audio clip corresponds to the current video clip in the Viewer, to open its waveform into the Audio Panel.

6. Use the Audio Panel transport controls and scrubber bar in the Source Viewer to move the playhead to the audio sync point that corresponds to that video sync point. This may be a clap, a beep, or some other staccato sound that’s easy to sync to. As you play through the clip, the bottom half of the Viewer shows a zoomed out waveform for the entire clip, while the top half of the Viewer shows a zoomed in section of the waveform that immediately surrounds the playhead. Hopefully, the sync point you’re looking for is a distinct, loud spike somewhere towards the beginning or the end (in the case of a tail slate) of the audio clip.

Aligning video and audio sync points with the Audio Panel set to show the Waveform panel
When you’ve found the audio sync point that matches the video sync point, click the Link/Unlink Audio button at the bottom right of the Audio Panel to embed the now synced audio into the video clip.

![Clicking the sync link button to lock sync](image)

The audio and video items are linked. At this point, you can use the newly synced clips in the Edit page, and use the Deliver page to export offline or online media with embedded audio for editing.

## Offsetting the Sync of Previously Synced Clips

If you need to offset the audio (or stereo 3D) sync of the items that make up a clip later on, you need only select the synced clip you want to resync in the Media Pool, then click the Waveform button at the top of the Audio panel to show the clip’s audio waveform, turn off the linked clip button, change either the audio or video sync points, and turn the linked clip button back on again.

You can also use two sets of commands for slipping the sync of any clip:

- **Trim > Slip Audio > Slip Audio One Frame Forward/Reverse**: (Option-Period and Option-Comma) Slips the audio/video sync of any clip in whole frame increments.
- **Trim > Slip Audio > Slip Audio One Subframe Forward/Reverse**: (Option-Right Arrow and Option-Left Arrow) Slips the audio/video sync of any clip in 1/10th frame increments.
- **Trim > Slip Eye > Slip Eye One Frame Forward/Reverse**: (Command-Option-Period and Command-Option-Comma) Slips the sync relationship between the eyes within a stereo clip in whole frame increments.

## Finding Synced Audio Files

When you’ve synced dual-system audio and video clips together in DaVinci Resolve, you can find the audio clip that a video clip has been synced to using the following procedure.

To find the audio clip that a video clip has been synced to:

- Show the Media Pool in List view, and reference file name in the Synced Audio column.
- Right-click a video clip that’s been synced to audio, and choose “Reveal synced audio in Media Pool” from the contextual menu. The bin holding the synced audio clip is opened and that clip is selected.
Displaying Synced Audio File Names on the Timeline

For certain workflows you may wish to see the name of the original audio file used in a synced dual system audio pair on the timeline tracks, rather than the name of the video clip it's attached to.

To display the filename of the original audio file used in a synced pair in the timeline:

1. Choose View > File Names. You cannot see synced audio file names unless you've set DaVinci Resolve to display the original file names.

2. Choose View > Show Synced Audio File Names. You should now see the names of the synced audio files superimposed on the audio clips in the Timelines, and the names of the video files superimposed on the video clips in the Timelines, even when they're synced.

Viewing the synced audio file names in the Edit page Timeline
Chapter 21

Modifying Clips and Clip Attributes

Once you’ve added clips to the Media Pool, you may find you have to make some changes to prepare it for use in your project. This chapter covers diverse tasks that include redefining the clip attributes associated with each source clip to reinterpret video and audio attributes, timecode values, and clip names, converting LTC timecode recorded on an audio track into usable timecode, chopping long clips into more manageable subclips, and creating stereo clips from left and right eye media.

Contents

Adjusting Media Pool Clips in the Inspector 367
Changing Clip Attributes 367
Video Attributes 367
Real-Time 3:2 Pulldown Removal 370
Audio Attributes 370
Timecode Attributes 373
Reel Name Attributes 374
Update Timecode from Audio – LTC 375
Changing Clip Thumbnails in the Media Pool 375
Creating Subclips 376
Removing or Changing Subclip Limits 376
Organizing Stereo 3D Media 376
Camera Raw Decoding 377
Adjusting Media Pool Clips in the Inspector

You can directly modify Media Pool clips in the Inspector, before you edit those clips into a timeline. This allows you to change the parameters of source media so that clips that are subsequently edited into a timeline carry those new settings with it. For example, you can prepare your material prior to editing by changing the clip’s file and RAW settings, adjusting the audio levels and EQ, or assigning it a specific lens correction, etc. Once modified, any part of that clip would have the correct Inspector parameters already in place when you edited them into your timeline.

For more information about using the Inspector in the Media Pool, see Chapter 19, "Using the Inspector in the Media Page"

Changing Clip Attributes

Using the Clip Attributes window, you can alter additional attributes for multiple clips all at once. This window has some overlap with other clip attributes that are editable directly from submenus within the Media Pool clip contextual menu.

To edit the attributes of one or more clips in the Media Pool of any page:
1. Select one or more clips in the Media Pool by Shift-clicking, Command-clicking, or dragging a bounding box around them.
2. Right-click one of the selected clips, and choose Clip Attributes.
3. Click to open the panel of the attributes you want to edit. If you’ve selected multiple clips, then making your alterations automatically checks the box of the attributes being changed.
4. When you’re finished, click OK to accept the changes.

You can also edit select clip attributes for clips that have been edited into the Timeline.

To edit the attributes of one or more clips in the Timeline of the Cut, Edit, or Color pages:
1. Select one or more clips in the Timeline by Shift-clicking, Command-clicking, or dragging a bounding box around them.
2. Right-click one of the selected clips, and choose Clip Attributes.
3. Click to open the panel of the attributes you want to edit. If you’ve selected multiple clips, then making your alterations automatically checks the box of the attributes being changed.
4. When you’re finished, click OK to accept the changes.

Video Attributes

These affect individual clip frame rate, geometry, and data levels.
The Video panel of the Clip Attributes Window

- **Video Frame Rate:** In cases where a clip’s frame rate was specified incorrectly by another application or recording device, or if there is no frame rate metadata available at all, you can change what DaVinci Resolve considers the frame rate of the source clip to be by either using this menu to choose a frame rate from 1 to 120 fps, or choosing Custom and entering a value from 1 to 32,000 fps (to accommodate high-speed and specialty format video). Changing a clip’s Video Frame Rate will change its duration and relative playback speed in DaVinci Resolve. A clip’s audio, however, will be unaffected. Please note, just because extremely high frame rate media is supported, do not expect real time performance at excessively high frame rates, and understand that what performance your workstation is capable of depends on its configuration and the speed of your storage.

- **Data Levels:** In certain circumstances, you may find that you need to manually choose appropriate data levels for clips that are not being interpreted correctly, choosing between Auto, Video, and Full. For more information on this setting, and how it affects the image data in your project, see Chapter 8, “Data Levels, Color Management, and ACES.”

- **Pixel Aspect Ratio:** In projects using a mix of media with different frame sizes, you can assign specific pixel aspect ratios using this drop-down menu.

- **Horizontal and Vertical Image Flip:** Modifies the horizontal and vertical image flip camera metadata for r3d clips, which is useful for stereoscopic 3D projects shot with a mirrored camera rig that reverses the media from one eye, or in cases where steadicam rigs result in upside-down clips. These settings are different from the Flip Image controls in the Sizing palette of the Color page.

- **Image Orientation:** For media that has an orientation setting, this lets you change the rotation of that media so that it’s correctly oriented. Four settings let you adjust by 0º, 90º right, 180º, and 90º left.

- **Input Sizing Preset:** You can use this panel to assign a Sizing palette preset to select clips. For example, if you have a special Input Format Preset for standard definition PAL widescreen clips that you’ve edited into a high definition project, you can do a sort in the Media Pool to isolate them, and then select them all and apply this preset.

- **Field Dominance:** By default, the Auto setting enables DaVinci Resolve to automatically determine whether a particular clip is Upper- or Lower-field dominant. If this automatic determination is wrong, you can choose Upper or Lower to manually override this.
– **Enable Deinterlacing**: (only available in Studio version) This checkbox is only enabled if "Enable video field processing" is turned off in the Master Settings panel of the Project Settings. Turning the Enable Deinterlacing checkbox on sets DaVinci Resolve to deinterlace clips using the Deinterlace quality setting that’s located in the Image Scaling panel of the Project Settings. Normal is a high-quality deinterlacing method that is suitable for most clips, while High is a more processor-intensive method that can sometimes yield better results, depending on the footage. The DaVinci Neural Engine option uses advanced machine learning algorithms to reconstruct the frame, which will ideally give even better results than the High setting.

– **Alpha Mode**: The options presented here depend on the format of the clip you’ve selected, since only certain formats (such as ProRes 4444, QuickTime Animation, OpenEXR, TIFF sequences, and so on) are capable of containing alpha channels. If you’ve imported clips with embedded alpha channels, this panel lets you enable or disable their use in DaVinci Resolve (by choosing None), choose the type of alpha channel (Premultiplied or Straight), or invert the alpha channel. If you select a clip that doesn’t contain an alpha channel, then most of these options don’t appear.

Super Scale High Quality Upscaling: For instances when you need higher-quality upscaling than the standard Resize Filters allow, you can now enable one of three “Super Scale” options in the Video panel of the Clip Attributes window for one or more selected clips. Unlike using one of the numerous scaling options in the Edit, Fusion, or Color pages, Super Scale actually increases the source resolution of the clip being processed, which means that clip will have more pixels than it did before and will be more processor-intensive to work with than before unless you optimize the clip (which bakes in the Super Scale effect into the optimized media), or cache the clip in some way.

The Super Scale drop-down menu provides three options of 2x, 3x, and 4x, as well as Sharpness and Noise Reduction options to tune the quality of the scaled result. Note that all of the Super Scale parameters are in fixed increments; you cannot apply Super Scale in variable amounts.

Selecting one of these options enables DaVinci Resolve to use advanced algorithms to improve the appearance of image detail when enlarging clips by a significant amount, such as when editing SD archival media into a UHD timeline, or when you find it necessary to enlarge a clip past its native resolution in order to create a closeup.

You may find that, depending on the source media you’re working with, setting Sharpness to Medium yields a relatively subtle result that can be hard to notice, but setting Sharpness to high should be immediately more preferable, while also sharpening grain and noise in the image to an undesirable extent at the default settings. However, while raising Noise Reduction will ameliorate this effect, it will also diminish the gains you obtained by raising Sharpness. In these cases, it’s worth experimenting with keeping Sharpness at Low or Medium so that Super Scale sharpens all aspects of a clip, but then using the Noise Reduction tools of the Color page (with their additional ability to be fine-tuned) to diminish the unwanted noise.
TIP: Super Scale, while incredibly useful, is an extremely processor-intensive operation, so be aware that turning this on will likely prevent real-time playback. One way to get around this is to create a string-out of all of the source media you’ll need to enlarge at high quality, turn on Super Scale for all of them, and then render that timeline as individual clips, while turning on the “Render at source resolution” and “Filename uses > Source Name” options.

Real-Time 3:2 Pulldown Removal
If you have 29.97fps interlaced material that was encoded with a 3:2 pulldown, DaVinci Resolve can reconstruct the original footage’s progressive frame rate in real time. For example, if you have source media from a film camera (24fps progressive) that has been telecined to NTSC video (29.97fps interlaced), DaVinci Resolve can pull the original 24 discrete film frames out of the various interlaced fields that make up the NTSC signal.

To remove 3:2 pulldown in real time:
1 Select one or more 29.97 fps interlaced clips in the Media Pool.
2 Right-click one of the selected clips and select Clip Attributes.
3 In the Video tab, turn on the Remove 3:2 Pulldown checkbox.
4 Set the Frame where the 3:2 cadence started in the “First Frame of Clip” drop-down (this is usually the “A” frame).
5 Click OK.

The footage will now behave like a 24fps progressive clip.

Audio Attributes
The Audio panel lets you alter the channel format and channel assignments for one or more clips. These settings affect what appears in the audio tracks of the Timeline when you edit a clip into a program. When you first import clips into the Media Pool, you can use the Audio Attributes panel to define which embedded audio channels can be exposed as tracks in the Edit and Fairlight page timelines for editing, and how they will appear.
Add Track Controls

A set of controls at the top of the Track/Channel list lets you add additional tracks to a clip. Adding additional tracks to a clip lets you remap that clip’s available channels to appear in the Timeline when you edit it.

- **Format:** A drop-down that lets you choose a format for new tracks that you add. The setting you choose here affects how many channels appear in the Channel Assignments list below, as well as what kind of Timeline audio track will be required to expose all channels of that clip. If you choose a Channel Format with fewer channels than are embedded in a clip, all extraneous channels will be disabled. The available options are:
  - **Mono:** Appropriate for single-channel clips
  - **Stereo:** Appropriate for clips with two-channel left/right audio
  - **5.1:** Appropriate for 5.1 surround mixes
  - **7.1:** Appropriate for 7.1 surround mixes
  - **Adaptive:** Appropriate for multiple-mono production audio, such as multi-channel recordings where a boom microphone, two separate lavaliere microphones, and a mixdown track are recorded simultaneously.

- **Tracks:** Lets you adjust how many tracks you want to add to the current clip or clips. Each track you add will result in an additional linked audio item being edited into an additional audio track when this clip is edited into the Timeline. For example, if you have a multi-channel production recording with four different microphones, you can add 3 mono audio tracks, and then assign each channel to a separate track to expose each channel as an individual audio clip in the Timeline for purposes of editing each microphone separately.
– **Add button:** Lets you add the tracks you’ve specified to the current clip or clips.

A clip with a single track of two-channel stereo audio at left, compared to a clip with two tracks of single channel mono audio at right

**Audio Track and Channel List**

The list below the Add Track controls show an entry for each track defined within the currently selected clip or clips. Pop-ups within this list let you redefine and map how that clip’s channels are spread across the differently mapped tracks you’ve created.

– **Format:** The format of each audio track. Can be Mono, Stereo, 5.1, 7.1, or Adaptive.

– **Source Channel:** Each track lists however many channels the specified format requires. A Stereo track has two source channels, a 7.1 track has eight source channels. Channels appear hierarchically underneath the track they belong to.

– **Track:** The name of each track in a clip.

– **Channel in Track:** The name of each channel in that track.

– **Delete Track button:** Hovering the pointer over a track reveals a trashcan icon you can click to delete that track.

A trashcan button you can use to delete an audio track within Clip Attributes; it only appears when you hover the mouse over a track

**Support for Mixed Audio Track Formats from Source Clips**

DaVinci Resolve also supports media with multiple audio tracks that have differently formatted channels embedded within them. For example, a clip with one stereo track, one 5.1 surround track, and six mono tracks can all be appropriately set up in the Audio panel of Clip Attributes after that clip has been imported.

The Audio panel of Clip Attributes now has controls over what format (Mono, Stereo, 5.1, 7.1, Adaptive) the channels embedded within a particular clip should be configured as. This means that you can set up clips with multiple tracks, each one using potentially different formats of audio employing different combinations of clips, which is handy for mastering.
Clip Attributes now lets you assign channels among different tracks with different channel assignments

**Timecode Attributes**

If you find yourself dealing with clips that have incorrect timecode, or timecode with an incorrect relationship to the EDL, XML, or AAF project you’ve been given, you can use these attributes to modify the timecode and reel name of clips in the Media Pool. None of these tools alter the source media on disk. They simply change the timecode metadata in your DaVinci Resolve project, which by extension affects the timecode of any media you render.

The Timecode panel of the Clip Attributes window
– **Current Frame Timecode:** Lets you assign a new time for the timecode at the currently viewed frame of the clip.

– **Slate Timecode:** In situations where source media comes from a shoot where a timecode slate was used during the shoot, then you can assign the slate timecode as a second timecode track that can be used for various operations, without changing the primary timecode of the clip, which may already be in use for program sync.

To set appropriate Slate timecode, select a clip in the Media Pool with a visible timecode slate, and move the playhead to a frame where the timecode in the slate is clearly readable. Then, open the Timecode panel of the Clip Attributes window, and type the timecode value you see in the image into the Slate Timecode field.

– **Offset Source Timecode:** If an entire set of clips has timecode that’s merely offset, you can correct the timecode offset for as many selected clips as you like.

### Reel Name Attributes

The “Assist using Reel Names” checkbox in the General Options panel of the Project Settings is an extremely important setting for controlling how the conform process works. By default it’s turned off, and Reel Names are left blank. This is fine for conform workflows where all you need is the file path or file name and source timecode to successfully identify which media files correspond to what clips. However, if you need more information than that to reconform the clips in your project, you can turn on the “Assist using Reel Names” checkbox to enable DaVinci Resolve to use one of four different methods to automatically define reel names for every clip in the Media Pool.

Using the Clip Attributes dialog, you also have the option of manually defining how one or more selected clips in the Media Pool have their Reel Names defined. This is useful when there are certain clips in a project that need to use a different method of reel name extraction, or manually entered reel names. Once you’ve used Clip Attributes to change the reel names of clips, those clips no longer automatically update when you change the “Assist using Reel Names” options in the Project Settings.

You must first turn on “Assist using Reel Names” in the General Options of the Project Settings, and choose a Reel Assist setting, for the reel name attributes in the Clip Attributes window to be editable.
– **Source clip file pathname:** Obtains the reel name by extracting it from each media file’s path. This makes it possible to extract a reel name from all or part of the file name, or from all or part of the name of any folder in the path that encloses that file. This extraction is defined using the Pattern field.

– **Pattern:** A code that defines how a reel name should be extracted from the source clip pathname. More information about creating patterns appears later in this chapter.

– **Media Pool bin name:** The reel name is obtained from the name of the bin in the Media Pool that encloses that clip. For example, in a stereoscopic workflow you might want to export offline stereo media with the “Left” and “Right” bin names in which they’re organized as reel names. Another example would be organizing VFX being incrementally processed in individually named bins, such as “VFX_Tuesday_10-12.”

– **Embedding in Source clip file:** Useful for file formats where the reel name is embedded within the media file itself. CinemaDNG and other digital cinema cameras, QuickTime files created by Final Cut Pro, and DPX frame files are formats that can contain reel name header data.

– **Source clip filename:** If there is no defined reel number, often it’s easy to just use the Source clip filename.

– **User Defined:** This option is only available when you manually alter the reel name for one or more selected clips in the Media Pool using the Clip Attributes dialog. Choosing User Defined lets you type any string of text you like to use as the reel name.

### Update Timecode from Audio – LTC

Some cameras do not offer the ability to sync to an external timecode source. Their recorded timecode may be time of day or free run timecode, but it would not be frame accurately synced to other cameras, the dual system audio recorder or the digital slate. This makes multi-cam or dual sound system syncing a time consuming manual operation. 

DaVinci Resolve offers a solution to this problem if, by connecting an externally generated timecode to the camera audio input, the video that’s recorded by the camera has a timecode reference recorded on the audio track during the shoot.

Select this clip, or clips, in the media pool, then right-click on one of the highlighted clips and select “Update timecode from audio - LTC.” DaVinci Resolve automatically and instantly updates the clip timecode using the LTC it finds on the audio tracks. You can now use the clips as though they were synced on set.

### Changing Clip Thumbnails in the Media Pool

When the Media Pool is in Thumbnail mode, each clip is represented by a small image that defaults to the first frame of that clip. You can scrub the thumbnail of any clip to view its contents using the pointer after hovering over it for a moment. However, when you’re done scrubbing, moving the pointer away from any clip returns its thumbnail to the first frame of media, which may or may not be representative of its contents. You can change this, if you like.

1. To customize the thumbnail of any clip:
2. Move the pointer over a clip you want to customize the thumbnail of.
3. Hover for a moment, then scrub to a representative frame.
4. Right-click that clip, and choose Set Poster Frame, or press Command-P.
To clear the custom poster frame of any clip:

- Right-click a clip, and choose Clear Poster Frame, or press Option-P.

Creating Subclips

Subclips give you another way of organizing media in the Media Pool, letting you break excessively long clips into shorter ones. For example, if the director of a project is fond of “rolling takes” where multiple takes are all recorded within a single clip, you can break these takes up by making them into subclips.

To create a subclip:

1. Select any clip in the Media Pool to open it into the Viewer.
2. Set In and Out points to define the section you want to turn into a subclip.
3. Do one of the following:
   - Right-click the jog bar and choose Make Subclip.
   - Drag a clip from the Viewer or Source Viewer into the Media Pool.

A new subclip appears in the Media Pool, automatically selected so that you can immediately edit its metadata in the Metadata Editor.

Once created, subclips appear and work like any other clip in DaVinci Resolve.

Removing or Changing Subclip Limits

Once created, you can right-click any subclip in the Media Pool or a timeline and choose Edit Subclip to open a dialog in which you can turn on a checkbox to use the subclip’s full extents, or to change the start or end timecode of the subclip via timecode fields, before clicking Update to modify the subclip.

Organizing Stereo 3D Media

When working with stereo media in DaVinci Resolve, one of the first tasks you must perform is that of syncing each stereo pair of clips to act as a single clip. This is easily accomplished so long as you’re careful about how you organize your media in the Media Pool.

Each set of right- and left-eye media should always be organized into separate left-eye bins and right-eye bins, to facilitate later syncing of these clips using the Stereo 3D Sync command in the Media Pool contextual menu. For more information about setting up media for stereo workflows, see the “Stereoscopic Workflows” section of Chapter 14, “Stereoscopic Workflows.”
Camera Raw Decoding

Camera raw media formats are so named because they capture raw color space data directly from the sensor of whatever digital cinema camera did the recording. Raw image data is not human readable, and must be debayered or demosaiced to convert the original raw data into image data that can be handed off to DaVinci Resolve’s image processing pipeline.

There are four ways you can control how camera raw media is debayered into a useful, “normalized” image for adjustment or output:

– The Camera Raw panel of the Project Settings contain groups of parameters that correspond to every camera raw media format that’s supported by DaVinci Resolve. Using these parameters in the Camera Raw panel, you can override the original camera metadata that was written at the time of recording, and make simultaneous adjustments to all camera raw media throughout your project.

– The Image Panel in the Inspector also contains the controls for every raw media format that’s supported by DaVinci Resolve. Allowing you to select all, some, or individual clips for raw debayering.

– The Camera Raw palette in the Color page lets you individually adjust Camera Raw parameters for individual clips in the Timeline.

– When you use Resolve Color Management (RCM) in a project that uses Camera Raw formats, color science data from each camera manufacturer is used to debayer or demosaic each camera raw file to specific color primaries with linear gamma, so that all image data from the source is preserved and made available to DaVinci Resolve’s color managed image processing pipeline. As a result, the Camera Raw project settings and Camera Raw palette of the Color page are disabled, because RCM is controlling the debayering of all camera raw clips, and all image data from the raw file is available for conversion to the Timeline Color Space you choose to work with as you grade.

For more information about each of the Camera Raw formats that can be adjusted in DaVinci Resolve, see Chapter 6, “Camera Raw Settings.”
Chapter 22

Using Scene Detection

If you have a program that someone has delivered as a single media file, with no accompanying EDL with which to split it up, you can use DaVinci Resolve’s Scene Detect window to automatically find the cut points and split it into individual clips, ready for grading.

Contents

- Scene Cut Detection on the Timeline (Studio Version Only) 379
- Scene Detection in the Media Pool 380
- The Scene Detect Window Interface 380
- The Scene Detect Viewers 380
- The Scene Detect Graph 382
- Cut List 383
- The Scene Detect Options Drop-down Menu 384
- An Example Scene Detect Workflow 384
Scene Cut Detection on the Timeline  
(Studio Version Only)

If you need to break down a previously edited video into its component clips for re-editing or color correction, you can now do so directly in an Edit or Cut page Timeline. Using the DaVinci Neural Engine, DaVinci Resolve can automatically analyze and split up an edited video into individual clips.

If you prefer, you can continue to use the original Scene Cut Detection tool found in the Media Pool and described later in this chapter.

To use Scene Cut Detection on the Timeline:

1. Select one or more clips you want to split on the Timeline. Alternately, you can limit Scene Cut Detection to just a portion of a clip by setting In and Out points on the Timeline around the section you want to analyze.

2. Choose Timeline > Detect Scene Cuts.

A dialogue box appears, “Detecting scene cuts in clips x of x.” This process can take some time, depending on the length, number, and complexity of the clips you’ve selected. When the Scene Cut Detection has finished, the clip you selected will be broken up into a number of through edits that now can be used as independent clips.

Checking and Fixing Your Results

If the Neural Engine has made an error, you can fix it manually by navigating to the cut using the Up and Down Arrow keys to go back and forth in the Timeline, and by then doing one of the following:

– **To remove a Cut**: Click the through edit to select it, and press the “Delete” key.

– **To make a New Cut**: Place the timeline indicator at the cut point, and choose Timeline > Split Clips (Command-1).
Scene Detection in the Media Pool

Initiating scene detection is easy:

To open a clip into the Scene Detect window:

1. Open the Media page, and use the Media Storage browser to find and select the clip you need to split apart. Do not add a clip you want to use scene detection on to the Media Pool first. You need to use Scene Detection before the clip has been imported.

2. Do one of the following:
   - Right-click the file and choose Scene Cut Detection.
   - Using the DaVinci control panel, press SHIFT DOWN and DECK/REVIVAL/SCENE on the T-bar panel.

The Scene Detect window opens up, containing the clip you selected.

The Scene Detect Window Interface

The Scene Detect window is divided into three main areas, the viewers, the Graph, and the Cut List. Together, these controls let you analyze the movie, examine the automatically found cuts, and manage the Cut List in preparation for sending back to your project.

The Scene Detect Viewers

A set of three viewers appear at the top of the Scene Detect window. These three viewers are designed to make it easy to test whether the playhead in the Scene Detect Graph is on a cut point or not. The leftmost viewer is the last outgoing frame of a detected cut point. The center viewer shows the first incoming frame of that cut point, and the rightmost viewer shows the second incoming frame of that cut point.
If the playhead in the Scene Detect Graph is directly on top of an edit point, the leftmost viewer should show a completely different frame than the center and rightmost viewers, which should be very similar to one another. This can be seen in the following example.

The Scene Detect viewers show the last frame of the outgoing clip, and the first two frames of the incoming clip.

If all three viewers appear to display a continuous series of frames, then you’re not looking at a cut point.

Underneath the viewers are a series of controls.

The Scene Detect viewer transport controls

- **Transport controls**: A set of seven transport controls include first frame, step back, play reverse, stop, play forward, step forward, and last frame.

The In, Out, Prune, and Show Cut List controls

- **In**: Lets you set a red In point, with which to define a range of the Scene Detection Graph to prune.
- **Out**: Lets you set a cyan Out point, with which to define a range of the Scene Detection Graph to prune.
- **Prune**: If you’ve identified a large number of false positive scene cuts (for example, a cluster of cuts corresponding to a dissolve from one shot to another), use the In and Out buttons to surround the undesirable range of scene cuts in the Scene Detect Graph, and then click Prune Scene Cuts to eliminate all scene cuts between these points that are within one frame of another scene cut. Within the group of identified cuts, the highest probability cut will remain while the other cuts are deleted.
Isolating scene cuts to prune with In and Out points, (Right) The result of clicking the Prune button to eliminate all unwanted scene cuts but one

Show Cut List: Shows and hides the Cut List, which shows the currently detected scene cuts.

The Scene Detect Graph

The majority of the bottom half of the Scene Detect window, to the left, consists of the Scene Detect Graph, which shows the scene detect analysis results after you’ve clicked the Start button.

Frames that DaVinci Resolve thinks are cut points appear as green vertical “scene cuts” of various heights. The height of each scene cut corresponds to the likelihood that frame is really an edit point, and not a swish pan, sudden jump in the motion of the frame, or abrupt change in color or lighting, all of which can fool the scene detection algorithm.

A horizontal magenta confidence bar lets you choose the threshold of confidence required for scene cuts to be added to the Cut List. If you drag this bar up above any shorter scene cuts of low confidence, those lines turn gray and are omitted from the Cut List.

NOTE: Dissolves and other transitions are not automatically detected, although dissolves most often appear as a triangular cluster of lines peaking in the middle.
Four controls appear underneath the graph.

- **Auto Scene Detect**: This initiates the scene cut detection process.
- **Add**: Lets you manually add a scene cut at the current position of the playhead. Sometimes two adjacent clips with similar color and lighting will appear to be a single clip to the scene detection algorithm. This lets you add scene cuts at frames where they weren’t initially found.
- **Delete**: Lets you manually delete a scene cut located at the position of the current frame indicator within the graph.
- **Zoom slider**: Lets you zoom into and out of the Scene Detect Graph to see more or less detail as you examine the results.

**Cut List**

At the lower right of the Scene Detect window, the Cut List displays one entry for each of the scene cuts that intersect the confidence bar.

The Cut List shows all currently detected cuts.

Three columns show each cut’s order number, frame number, and timecode value. You can select items in the Cut List to evaluate each cut using the three viewers above. Whenever you select a new item in the Cut List, the playhead jumps to that frame in the Scene Detect Graph.

**To select items in the Cut List:**

- Click any item in the Cut List.
- Press N (next) or the Down Arrow to select the next item down.
- Press P (previous) or the Up Arrow to select the next item previous.
As you move up and down the list, you can delete items that you can confirm aren’t real cuts using the viewers above. If it’s a long list and you don’t have time to check it all at once, it can be saved for later recall using commands found in the Scene Detect Options drop-down menu.

Once you’re finished checking the list and are satisfied that each cut is accurate, you can use it to split the media file into individual clips in the Media Pool by clicking “Add Cuts to Media Pool,” located immediately below.

The Scene Detect Options Drop-down Menu

The Options drop-down menu, located at the upper right-hand corner of the Scene Detect window, contains a variety of commands.

- **Reset Zoom:** Sets the zoom level of the Scene Cut Graph such that the entire clip fits within the current width.

- **Reset Marks:** Clears the current In and Out points you’ve set.

- **Prune Scene Cuts:** If you’ve identified a large number of false positive scene cuts (for example, a cluster of cuts corresponding to a dissolve from one shot to another), use the In and Out buttons to surround the undesirable range of scene cuts in the Scene Detect Graph, and then click Prune Scene Cuts to eliminate all scene cuts between these points that are within one frame of another scene cut. Within the group of identified cuts, the highest probability cut will remain while the other cuts are deleted.

- **Save Scene Cut:** Saves the current scene cut detection information, including the probability metadata, to disk. Scene Cut files use the file extension .sc and can be reimported later to continue working on a lengthy scene detection task.

- **Load Scene Cut:** Imports an existing .sc file into the Scene Detect window. You must first open the media file you’re working on into the Scene Detect window before you can load a Scene Cut file.

- **Save EDL:** Exports the Cut List as a CMX-style EDL.

- **Load EDL:** Loads a CMX-style EDL into the Cut List, letting you use the cut information from the EDL during the Scene Cut Detection process.

- **Auto Cue:** When enabled, the playhead jumps to each new scene cut as it’s detected when you initiate scene detection. This lets you evaluate each scene cut as it’s found using the three viewers above.

An Example Scene Detect Workflow

This section describes an ideal workflow for using scene detection without an EDL.

**To scene detect a media file:**

1. Locate a media file to scene detect using the Media Storage browser of the Media page.

2. Verify its frame rate and if it uses drop-frame timecode, and make sure that the “Timeline frame rate” matches the “Use drop frame timecode” parameter in the Master Settings panel of the Project Settings. These parameters are not automatically set if the project already has media in the Media Pool, and you may have problems if they don’t match your media.

3. Right-click the media file, and choose Scene Cut Detection.

4. When the Scene Detect window appears, click the Options drop-down menu and choose Auto Cue (it should be on by default, but it’s always good to check), then click Auto Scene Detect.

Scene detection initiates, and you can evaluate each scene cut as it’s found. If any scene cut looks wrong (three sequential frames in a row), note its place in the list for future evaluation.
When DaVinci Resolve has finished scene detection, move the playhead to some of the shorter scene cuts, and verify if they’re actual cuts by checking the three viewers above. If the frames being displayed are “different-same-same,” then it’s a genuine cut.

If the frames being displayed are “same-same-same” (actually three sequential frames), then these aren’t cuts.

TIP: Fast camera motion such as whip pans, sudden changes in lightness such as camera flashes, or even film coming up to speed causing the shutter to “flash” can confuse the analysis, which looks for large changes in the image.

If there are numerous low-confidence scene cuts that you’ve verified aren’t cuts, drag the magenta confidence bar so that the low-confidence scene cuts fall below it to automatically remove them all from the list.

Next, you may want to move down the Cut List, evaluating each scene cut to verify that it’s correct. Click the first scene cut in the list, check it, then press the keyboard Down Arrow key to select the next list item down, check it, and repeat until you’ve checked every item in the list. If you need to move back up the list, you can press the Up Arrow key to select the previous list item. If any item is not a cut point, click the “Delete” button at the bottom left corner of the Scene Detect window to eliminate that scene cut.

If there are sections in the Scene Detect Graph with dense groups of spikes, these are probably frames with types of motion that confused the Scene Cut Detector. To delete this unwanted “noise” in the data, use the In and Out buttons to isolate the data, and then click “Prune” to delete these unwanted scene cuts.

If there’s a gap between any two scene cuts that you’re positive should have another scene cut, then scrub the playhead or use the transport controls to find the missing cut, and click the “Add” button at the bottom left corner of the Scene Detect window to add another scene cut.

TIP: Adjacent shots with very similar ranges of color and contrast may sometimes go undetected by the scene detection algorithm. If you know of scenes in the media you’re analyzing that are like this, you may want to scrub through them a bit more carefully to make sure you’re not missing anything. However, if you find you’ve missed a cut later, you can always use the Split Clip control in the Edit page timeline to add a new edit point.

When you’re confident that the Cut List is accurate, split the media file into individual clips in the Media Pool by clicking “Add Cuts to Media Pool.”

When the Conform Settings dialog appears, click OK if you checked your settings in step 2.

Close the Scene Detect window.

The individually cut up clips of the media file you analyzed now appear in the Media Pool, and you can edit the entire sequence of clips into a new Timeline in order, ready for grading.
Chapter 23

Ingesting From Tape

DaVinci Resolve is capable of capturing media from tape using a compatible video input device, such as a Blackmagic Design UltraStudio or DeckLink card. Device control is supported.

Contents

Tape Ingest 387
The Tape Capture Interface 387
Setting Up to Capture From Tape 388
Deck Settings 388
Capture 389
The Three Methods of Capture 390
Using Capture Now 390
Logging and Capturing Individual Clips 390
Logging and Capturing Multiple Clips 390
Batch Capture Via EDL 391
Tape Ingest

This chapter covers how to capture media from tape directly into the Media Pool in DaVinci Resolve. Whether you need to capture a handful of clips to incorporate into an existing project, or you need to recapture every clip corresponding to the events of an EDL, you can use the Media page in Capture mode to capture from any device-controllable deck via a compatible video interface.

To switch to tape capture in the Media page:

– Click the Capture button, located to the left of the Interface toolbar at the top of the Media page.

The Media page updates to reflect the relevant controls for editing to tape, and the Audio panel is replaced by a dedicated set of capture metadata and controls to help you track the resulting clips.

The Tape Capture Interface

While in Capture mode, the Media page is used to control the VTR, in order to establish In and Out points for logging or capturing a selected range of the tape.

– **Transport controls**: The transport controls, while similar in appearance to those used when simply playing through selected clips in the Media page, now work to control the VTR.

– **Shuttle control**: A shuttle control appears in what was formerly the scrubber bar, which lets you shuttle through the range of reverse and forward speeds compatible with the connected deck.

– **In and Out controls**: In Capture mode, the In and Out buttons to the right of the transport controls define a range of the tape from which to capture.

– **Capture panel**: The panel automatically switches to the Capture panel, with tape-specific metadata and capture controls. Populating File Name Prefix updates the file name preview that’s shown above in the Header, that also shows the Capture directory, Resolution, and Frame Rate specified in the Capture and Playback panel of the Project Settings.
Setting Up to Capture From Tape

Before you begin capturing from tape, you need to adjust a variety of settings in the Capture and Playback panel of the Project Settings. Two groups of settings, in particular, need to be defined.

Deck Settings

These settings affect both capture and playback when using the Tape Ingest options of the Media page, or the Tape Output options of the Deliver page.

- **Video capture and playback**: You can choose the video format (frame size and frame rate) with which to output to tape from this drop-down menu. HD timelines can be downconverted to SD, and SD timelines can be upconverted to HD using the format conversion of your DeckLink card.

- **Use left and right eye SDI**: A checkbox that enables the Blackmagic Design DeckLink HD Extreme 3D+ to ingest and output muxed stereoscopic video when used with supported VTRs, such as HDCAM SR decks with 4:2:2 x 2 mode. (When muxed stereoscopic signals are ingested, each eye is separated into individual left-eye and right-eye image files.)

- **Video connection operates as**: Selects between the available signal options: Use 4:4:4 SDI and Enable Single Link. Which options are available depend on which video capture card you are using.

- **Data Levels**: Lets you specify the data range (normally scaled or full range) that's used when ingesting from or outputting to tape. This option switches the data range of the signal output by your video capture card, but only during capture from tape in the Media page, or output to tape in the Deliver page. When capture or output is not currently occurring, your video capture card goes back to using the identically named data range setting in the Master Settings panel of the Project Settings pane, which governs how you monitor the signal being output on an external broadcast display or projector.
– **Video bit depth:** 10-bit is the only available option.

– **Use deck autoedit:** If supported by your video deck, this is the best method to record video to the deck, as it enables the deck to roll the edit using the specified preroll, and control the edits via serial device control. If this checkbox is turned off, a basic edit On/Off mode is used by the deck, with the potential for frame inaccuracies if the "Non auto edit timing" setting is not properly adjusted.

– **Non auto edit timing:** Adjusts the edit synchronization of the connected deck when auto edit is turned off.

– **Deck preroll:** Sets the number of seconds for preroll. How much is appropriate depends on the performance of your deck.

– **Video output sync source:** When using a DeckLink card this is set to Auto. Other capture cards may require you to set the sync source to “Reference” for playout and “Input” for ingest. This setting is only available if you have the DVS card installed on your system.

– **Add 3:2 pulldown:** Inserts or removes the 3:2 pulldown required to record or play 23.98 fps media to or from a 29.97 tape format.

### Capture

These settings are used when you use the Capture mode in the Media page to capture clips from tape into the Media Pool, or when controlling the Cintel Film Scanner to scan film of different formats.

– **Capture:** Lets you choose whether to capture both Video and Audio, or Video only.

– **Video Format:** The format captured media will be saved to. When capturing from tape, the available options are DPX and QuickTime.

– **Codec:** The codec used to write captured media. When capturing from tape, these include the various type of Apple ProRes, 8- and 10-bit YUV 422, 10-bit RGB, and the various types of DNxHD.

– **Save clips to:** A field that displays the directory path to which media files captured from tape are written. You want to choose a volume that’s fast enough to accommodate the data rate of the media format you’re capturing.

  – **Browse:** Click this button to choose a directory to write captured media to. The directory you choose appears in the field above.

  – **Save in this folder path:** A series of checkboxes lets you specify what other information to use to define the directory hierarchy that will hold the captured media. Every checkbox you turn on adds an additional directory with a name defined by that checkbox’s metadata. You can choose any or all of the following: Program name, Clip number, Reel number, Roll/Card.

  – **Apply reel number to:** Lets you choose how to write the reel name. Two checkboxes let you write the reel name to the file’s name, and/or to the Header data.

  – **Use prefix:** A field lets you type in a prefix to be used in the media file’s name. This lets you add text identification that will make the media more easily identifiable and searchable.

  – **Apply prefix to:** Two checkboxes let you choose to use the prefix you typed in the file name, and/or in the folder name.

  – **Use frame number with:** When capturing to image sequences, you can choose how many digits to use when writing the frame number into the name of each frame file.

  – **Set batch ingest handles to:** Lets you add additional frames of handles to the beginning and end of each scanned clip when batch capturing with the scanner.

  – **Input:** A drop-down that lets you choose how many tracks of audio to capture, from 2 to 16.
The Three Methods of Capture

Once you've set up all relevant settings in the Project Settings window, including at minimum “Video Capture and Playback,” “Capture Clips Saved to,” and Apply Reel Name to” settings, then you’re ready to start capturing. Depending on your workflow, there are three methods of capturing from tape that you can use.

For all capture methods, media can be ingested as QuickTime Movies or DPX image sequences.

Using Capture Now

If you simply need to capture a section of tape quickly, you can use the Capture Now command.

To Capture Now:

1. Use the transport controls and the In button to identify what you want to capture.
2. Enter all relevant information into the various fields of the Metadata Editor. The Header updates to show a preview of the file name that will be saved.
3. Use the transport controls to start playback, and then click the Capture Now button at the bottom of the Metadata Editor.
4. When the section of tape you wanted to record has finished, click Capture Now again to stop capture.

A new clip appears in the Media Pool, automatically placed in a new folder in the Media Pool with a name defined by the timecode value converted into a frame count, based on the ingest frame rate. For example, 00086400.dpx is the file name of a clip captured at timecode 01:00:00:00.

Logging and Capturing Individual Clips

If you’re capturing an exact range of tape, or multiple sections at once, you can also work by logging each section of tape you want to capture in advance, before using the Capture Clip or Batch Clips commands in a second step.

To capture a single clip using device control:

1. Use the transport controls to find the beginning of the section of tape you want to record, and click the In button. Then, find the end of the section of tape you want to record, and press the Out button.
2. Enter all relevant information into the various fields of the Metadata Editor. The Header updates to show a preview of the file name that will be saved.
3. When you’re finished, click Capture Clip.

Deck control is automatically used to play through the specified range of tape and capture that clip. When capture is complete, the new clip appears in the Media Pool.

Logging and Capturing Multiple Clips

For efficiency’s sake, you can also log multiple clips at once, from multiple tapes if necessary, and then batch capture them all at once.
To log one or more clips:

1. Use the transport controls to find the beginning of the section of tape you want to record, and click the In button. Then, find the end of the section of tape you want to record, and press the Out button.

2. Enter all relevant information into the various fields of the Metadata Editor. The Header updates to show a preview of the file name that will be saved.

3. When you’re finished, click Log Clip.

That clip is added to the Media Pool as an offline tape clip, indicated by a black icon with a tape badge.

To batch capture one or more logged clips:

1. (Optional) Put the Media Pool into List view, and click the Reel No column header to sort the Media Pool clips by reel number. This makes it easier to select a range of clips to capture from a particular reel.

2. Select one or more offline tape clips in the Media Pool that come from a particular reel.

3. Click Batch Clips, at the bottom of the Metadata Editor. To interrupt capture at any time, click Batch Clips again.

Deck control is automatically used to play through the current tape in the VTR and capture every logged clip you’ve selected that can be found on that tape, starting with the clip with the lowest timecode value and ending with the clip having the highest timecode value. A progress bar with accompanying text shows how much longer to go until capture is complete. As each clip is captured, its corresponding logged clip in the Media Pool updates with a thumbnail reflecting the captured media.

When DaVinci Resolve finishes capturing all clips from a particular reel, Batch Capture stops.

Batch Capture Via EDL

You can also use an EDL to create offline tape clips, one for each event in the EDL, with which to batch capture all the media necessary to conform a project from tape.

To import an EDL as a batch capture list:

1. Open the Project Settings, click Master Panel in the sidebar, and make sure of the following:
   - Set “Timeline frame rate” to the frame rate of your EDL.
   - Turn on “Use drop frame timecode” if your EDL requires it.
   - Make sure “Use Timecode” is set to “Embedded in the source clip.”
   - Turn on “Assist using reel names from the.”
2 Choose File > Import Batch List From EDL.

3 When a Conform Settings dialog appears asking you to confirm the current Project Settings, click OK if the settings are good.

4 Use the controls of the Select EDL files dialog to select one or more EDLs, then click Open. If you select multiple EDLs, then every event in each EDL is imported at once.

5 In the dialog that appears next, choose a frame rate to conform the EDL at, and click OK.

Each event in the EDL now appears as offline tape clips in the Media Pool, ready for capturing. If you load an EDL and there are already clips in the Media Pool that have the same reel name and start timecode as events in the EDL, DaVinci Resolve will not create new offline tape clips for those.

6 (Optional) Put the Media Pool into List view, and click the Reel No column header to sort the Media Pool clips by reel number. This makes it easier to select a range of clips to capture from a particular reel.

7 (Optional) If there are any offline clips that you don’t need to capture, you can remove them from the Media Pool by right-clicking them and choosing Remove Selected Clips.

8 Select which of the offline tape clips you want to capture. It’s best to select ranges of clips that come from the same reel.

9 Click the Capture mode button to the left of the transport controls, and then click Batch Clips to begin capture. To interrupt capture at any time, click Batch Clips again. Deck control is automatically used to play through the current tape in the VTR and capture every logged clip you’ve selected that can be found on that tape, starting with the clip with the lowest timecode value and ending with the clip having the highest timecode value. A progress bar with accompanying text shows how much longer to go until capture is complete. As each clip is captured, its corresponding logged clip in the Media Pool updates with a thumbnail reflecting the captured media.

When DaVinci Resolve finishes capturing all clips from a particular reel, Batch Capture stops.
Chapter 24

Capturing From the Cintel Film Scanner

This chapter details how to ingest scanned film using DaVinci Resolve settings and workflows to control the Cintel film scanner.

Contents

Controlling the Cintel Film Scanner 394
The Cintel Scanner Interface 395
Film Scanning Workflows 402
Adjusting the Color of the Scanner 404
Scanning One or More Sections of Film 405
Extracting Audio 406
Audio Extraction Settings 407
Color Space and Sizing 409
Controlling the Cintel Film Scanner

The Blackmagic Cintel film scanner is a compact, easy to use, real time film scanner capable of converting 35mm and 16mm (with a separately purchased gate) positive and negative film formats into Cintel Raw Image (CRI) digital files that can be organized, edited, and graded using DaVinci Resolve, delivered to any format DaVinci Resolve can output, and archived for later use.

DaVinci Resolve can control any Blackmagic Cintel film scanner that’s connected to your computer via Thunderbolt or PCIe. Once connected, the Film Scanner controls in the Media page can be enabled, which let you choose the film type to be scanned, align the film frames to the sensor, adjust the scanner’s light source for optimal exposure and color, and choose whether to use the scanner’s hardware-based Automatic Perf Detection to perform image stabilization.

**NOTE:** This chapter of the DaVinci Resolve manual describes the use of a Cintel film scanner connected to DaVinci Resolve for the purpose of ingesting scanned film. For other operational inquiries, please see the documentation that accompanies the scanner itself, or visit the Blackmagic Design support page on the web to download it.

This section of the manual shows you how to use settings and features in DaVinci Resolve’s film scanner panel to control your scanner. For example calibrating your scanner, adjusting the light source strength and color temperature, setting image stabilization, and more. You can even set how gentle your Cintel scanner handles film which may have become delicate with age.

**TIP:** DaVinci Resolve saves all scanner settings in your current project.
The Cintel Scanner Interface

Click on the ‘capture’ button in the UI toolbar at the top of the DaVinci Resolve screen to set the media page to control your Cintel scanner. Open DaVinci Resolve’s film scanner panel to set up, calibrate, and choose options for logging or scanning a selected range of the currently spooled roll of film. If you want more room for viewing the Cintel scanner controls, click the full height button that’s all the way to the right of the UI toolbar, and turn off the ‘metadata’ panel.

Cintel scanner controls in the Media page

- **Transport Controls**: The transport controls under the viewer, while similar in appearance to those used while in playback mode, now work to control the Cintel scanner. Additional controls appear for moving forward or backward a frame at a time.

- **In and Out Controls**: In Cintel Scanner mode, the In and Out buttons to the right of the transport controls define a range of the film roll from which to capture.

The following groups of settings appear to the right of the ‘media’ page viewer when in Cintel Scanner mode to scan clips from film into the media pool.

**Calibration**

This option lets you calibrate the optics of the scanner to eliminate optical blemishes or dust that cannot be removed. Please note that this feature does not remove dust from the film itself.

The calibration button can be used to help remove dust or small blemishes from the optics of your Cintel scanner.

- **Calibrate**: This button lets you eliminate light optical blemishes and dust from the optics of the Cintel scanner via digital calibration. While it’s recommended to “spray dust” the optics before scanning new material, it’s possible over time for some blemishes on the optics to be unremovable, in which case using the calibrate button will eliminate them from the scanned image.

   The skid plate does not normally need to be removed for calibration, however, in cases where there is severe dirt, remove the skid plate, dust it, and then reinstall it. Use the ‘calibrate’ button
before you load film into the scanner, while there’s nothing in the optical path, to remove any remaining optical blemishes or dust.

**TIP:** Calibrate the optics with the skid plate installed and correctly aligned, as this assists with image stabilization and offers the best image quality.

Film Type

These controls let you select the type of film you’re scanning, align the film with the sensor, and choose what speed you’re scanning at.

- **Film Type:** Lets you choose what type of film you’re scanning. The choices are positive, negative, interpositive, and internegative. HDR scanning offers an improvement for all these film types. Select the reel type you’re scanning from 35mm 2, 3, and 4 perf, and 16mm.

**TIP:** The scanner automatically detects whether the film is 35mm or 16mm.

**NOTE:** When scanning interpositive and internegative film, the increased density of the film requires slightly extended pulse durations from the light source. Normally, this does not affect the scan, however, a slight reduction in resolution may occur when scanning at above 12 frames per second. If you do notice a difference in resolution, simply reduce your scanning speed to 12 frames per second or less.

- **Enable 2 Pass HDR Scan:** Enables high dynamic range multi pass capture. It is important to perform an ‘auto black’ or ‘auto white’ on a frame with a wide dynamic range as it determines the high and normal exposure levels from your selected frame.

- **Perf nudge:** Used for making fine adjustments of the perf position relative to the scanner gate aperture. Command-J nudges up, while Command-L nudges down.

- **Frame:** These buttons are push and hold to activate. When on, the film is slowly advanced to move the frame up or down and when released the film stops in place. This is useful for aligning the film frame with the scanner’s sensor. Using the ‘perf nudge’ and ‘frame’ buttons, you want to align the visible film frame so the bottom of the previous frame and the top of the next frame are just visible at the top and bottom of the viewer, and the current frame is centered vertically.

It’s important to make sure the image in the viewer is not zoomed in when you do this. Command-Left Arrow on your keyboard moves the frame up, while Command-Right Arrow moves the frame down.
– **Scan Speed:** With adequate disk performance, you should be able to scan at 30 fps. However, if you’re scanning to a slow hard drive, you can reduce the scanning speed to a frame rate that’s suitable for your workstation without dropping frames.

– **Supply:** Sets the wind direction of the left-hand side feed spool. While auto-detection will prevent incorrect operation, you should manually configure the reel winding direction based on how each film roll is wound.

– **Take up:** Sets the wind direction of the right-hand side take up spool. While autodetection will prevent incorrect operation, you should manually configure the reel winding direction based on how each film roll is wound.

– **Use Film Reel:** Small film reels have a different weight and inertia compared to large film spools, and this can affect the transport system. Tick this box to switch to settings that offer improved stability for small film reels.

– **Focus Assist:** Enables luminance peaking on your scanner’s HDMI monitor output, plus the viewer inside DaVinci Resolve’s film scanner panel, which makes it easy to obtain optimum focus adjustments.

**Light Source**

These controls let you adjust the scanner’s light source to adjust the optimal Dmin, which is the minimum scanned signal value, plus the color temperature of the scanned material. Use the built-in software scopes in DaVinci Resolve to help set your light source to its optimum level settings. Scopes can be opened in the Media page by choosing Workspace > Video Scopes > On. You can adjust these settings to make sure you’re not clipping image data during the scanning process.

![Light Source controls in the Media page showing the default uncalibrated status of the light source (left), and the status when calibration is successful (right)](image)

– **Light Source master wheel:** The vertical light source master wheel is located next to the color wheel and adjusts the intensity of the light source used to illuminate the film, raising or lowering the RGB channels all at once. For typical negative film, this lets you adjust the black point of the film image, which is the darkest part of the image. In negative film, this in fact corresponds to the highlights of the film image. Adjust the light intensity to sit just above the typical Dmin value of 95, as measured on the histogram of the video scopes, which guarantees that the highlights won’t be clipped by a Cineon-style LOG conversion. For positive film, simply adjust the master wheel so that no part of the signal is being clipped.

– **Auto Black and Auto White button:** Analyzes the current frame displayed in the viewer and does an automatic adjustment to set the black point for negative, or for print to set the white point. For positive film types, the ‘auto black’ button changes to ‘auto white’.
**TIP:** Whenever you change film type, gauge or enable HDR, the auto black/white calibration is reset. The status indicator under the auto black/white button reminds you to recalibrate the LED light source to help ensure the highest quality scans or inform you if any problems occur.

- **RGB controls:** By default, a color balance control lets you adjust all three color channels by varying amounts to alter the color temperature of the light source used to illuminate the film, while the adjusted R, G, and B values are displayed in three fields below. Optionally, you can choose to put this control into ‘color bars’ mode using the mode pop-up to the right of the ‘light source’ title bar, which changes this control to three vertical red, green, and blue color channel sliders.

**Image Stabilization**

These controls let you enable and disable as well as control image stabilization to eliminate vertical film hop.

![Image Stabilization controls in the Media page](image.png)

- **Image Stabilization enable/disable control:** The dot to the left of the ‘image stabilization’ title bar lets you enable or disable your scanner’s hardware-based image stabilization altogether. While hardware stabilization is typically desirable when you have high quality perforations, you may want to turn this option off if the condition of the perforations is poor and you decide to use DaVinci’s software based stabilization instead.

When image stabilization is enabled, a horizontal X axis detection overlay is displayed in the viewer, highlighting the edge of the film perforation that will be used as the reference for stabilization. This overlay is automatically hidden when recording. Image stabilization is enabled by default.

- **Enable X and Y checkboxes:** Enable X and enable Y lets you choose whether to use hardware image stabilization to fix horizontal gate weave and vertical gate hop respectively. If the results are unsatisfactory with both axes enabled, you can turn off the axis that’s causing issues with stabilization.

- **Horizontal Position slider:** Your Cintel scanner attempts to automatically place the stabilization detection overlay at the best location, with reference to the perforation shown on the currently loaded frame, for the best stabilization result.

You will notice a thin transparent line in the blue alignment overlay. For optimum stabilization, this line should touch the edge of the perforation. If the automatic positioning is not ideal, you can manually move the overlay to a more ideal position, either by dragging it in the viewer with your mouse, or by using the horizontal slider.

Ideal placement of the stabilization overlay should position the clear line in the alignment overlay on the edge of the perforation, as shown in the example image. With the overlay correctly positioned, this enables hardware stabilization of gate weave along the X axis.

Image stabilization automatically manages vertical gate hop when you select the ‘enable y’ checkbox. It needs no further adjustment and works in conjunction with horizontal stabilization.
Adjusting the horizontal position of the stabilization overlay. In this screenshot, the overlay is not aligned with the edge of the perf.

Hardware stabilization control correctly positioned over a perforation in the viewer. The transparent stripe in the stabilization overlay touches the edge of the perforation.

With the 16mm HDR skid plate installed, the stabilizer aligns automatically to the other side of the perforation to avoid interfering with the film image and improve horizontal stability. When using a 'non-HDR' 16mm skid plate, it functions the same as the 35mm skid plate.

To closely check the results of your stabilization settings before capturing, set the viewer to full resolution. Simply click on the options settings at the top right corner of the viewer and select 'Full Resolution Preview' from the menu. This setting does not affect the stabilization feature, but enables the best possible preview so you can monitor how well it is performing.

It’s worth mentioning that this setting will remain set until you change it back to your previous setting. Full resolution is very GPU intensive and may result in some frame lag. For best performance, turn full resolution off after checking stabilization.

**Film Protection**

These controls are intended to allow delicate film to be handled gently by the Cintel Scanner. Fast acceleration and shuttle speeds can be hard on archival footage, so it’s recommended to lower both of these sliders from their defaults whenever you’re scanning older film.
The ‘Acceleration’ and ‘Shuttle Speed’ sliders should be lowered when scanning older, delicate archival film.

- **Max Acceleration**: Sets the maximum change in speed to increase or decrease by 5-30 fps per second.
- **Max Shuttle Speed**: Changes the speed of shuttling from one section of film to another between 1–100 frames per second for 35mm film, and between 1–200 frames per second for 16mm film.
- **Film Tension Adjust**: If your Cintel Scanner has sprocket wheels, this setting gives you the ability to adjust the amount of tension applied to 35mm film. For example, when loading delicate archival film, or compensating for film shrinkage. There is no possible way you can damage the film with the ‘film tension adjust’ setting. The adjustment values are very small and only gentle changes are all that’s required to prevent sprocket picking.

If your Cintel Scanner has capstans, sprocket picking cannot occur so this setting is disabled.

### Editing Capture Info Metadata

When DaVinci Resolve is used in conjunction with Cintel Scanner, a set of capture metadata fields appears at the bottom of DaVinci Resolve’s film scanner panel. The ‘capture info’ panel has editable metadata fields that describe capture properties such as where to save files, the type of codec, frame rate, and the format of file names. This metadata is attached to your clips and can be read on the media page.

Before you begin scanning, you may want to adjust some of the project settings.
Before you begin a film scanning session, scroll down to the ‘capture info’ section of DaVinci Resolve’s film scanner panel to make sure the scanned files are being saved to the directory and volume where you want them. Click the ‘browse’ button and choose a location from the file destination dialog. It’s good to do this first, as this step is easy to forget.

When you have a Cintel Audio and KeyKode Reader fitted, this menu gives you options for ‘audio only’ so no images will be captured, or ‘image and sound’. Alternatively, you can capture ‘image only’ if audio is not important.

The resolution of the capture files depends on the source film format so this field cannot be edited.

DaVinci Resolve selects the ‘Cintel Raw’ codec for lossless compression by default, or you can choose ‘Cintel Raw 3:1’ for even smaller file sizes.

Specifying the frame rate that the film was originally shot at. DaVinci Resolve automatically adjusts the timeline frame rate based on this value. This setting is unrelated to capture or transport speeds.

When using the optional Audio and KeyKode Reader accessory to scan audio, the reader will automatically adjust for frame rate to maintain an overall sample rate of 48kHz. Timecode output is supported for 24, 25 and 30 fps, and for other frame rates no timecode signal is outputted.

Prefix to help identify the scan. This can be the name of your project, such as the title of the film you are scanning.

Select this checkbox to prefix your scans with a timestamp as well as the ‘file name prefix’ you specified. Your clips will be saved to independent sub-folders in the destination folder. This checkbox is selected by default.

If you want to save all your clips together in one master destination folder without the timecode in the file name, simply deselect the checkbox.

NOTE: If you don’t make capture names unique with the timestamp prefix and the files go into the same location, this could potentially overwrite files.

These are ways to identify the clip with metadata.

You can use these color coded flags to tag clips.

Corresponds to ‘circled take’ metadata in the media pool.

Adds a clip to the media pool. After you mark ‘in’ and ‘out’ points for a section you want to scan, confirm the metadata is correct, and then click ‘log clip’. For more information, refer to the ‘Logging and Capturing Individual Clips’ and ‘Logging and Capturing Multiple Clips’ sections in the DaVinci Resolve manual.

These scanning buttons offer different methods to capture clips. For more information about scanning buttons, refer to the ‘Scanning One or More Sections of Film’ section of this manual.
Film Scanning Workflows

The following sections describe how to scan film using DaVinci Resolve and to control the Cintel scanner. Throughout, the features outlined in the previous section are presented in the order in which you’ll perform each step of the scanning process.

Before You Begin

Before turning your scanner on and loading film, you should first dust the gate to make sure your scans are as clean as possible. This can be accomplished using compressed air, but if the gate is extremely dirty, you can remove it to give it a more thorough cleaning. Once that’s finished, turn on the Cintel Scanner, open DaVinci Resolve and create the project you’ll be using to scan film, and then click the ‘Cintel scan’ button on the media page. Now click the ‘Film Scanner’ tab to select DaVinci Resolve’s film scanner panel.

Before you load film into the scanner or do anything else, click the ‘calibrate’ button at the bottom left of the film scanner panel. While you should always dust the gate of the scanner before loading a new reel of film, clicking the calibrate button eliminates any unremovable blemishes in your scanner’s optics from the scans you’re about to make.

Load and Align the Film

Load the film you want to scan. In the presence of an image the scanner will automatically align a frame. You should note that the image may be framed incorrectly if you first load blank film leader.

Next, choose the film type. If necessary, use the ‘perf nudge’ and ‘frame’ buttons to manually improve the alignment of the framing bar to the scanner’s sensor such that the bottom of the previous frame and the top of the next frame are just visible at the top and bottom of the viewer, and the current frame is centered vertically. It’s important to make sure the image in the viewer is not zoomed in when you do this.

Focus the Scanner

Just as you need to focus the lens on a camera, you’ll need to focus the projected film image on your scanner’s sensor. To achieve perfect focus, turn on the Focus Assist checkbox in the Film Scanner capture settings of DaVinci Resolve. This superimposes a focus peaking overlay over the Ultra HD image that’s output from the scanner’s HDMI output, and is also displayed in DaVinci Resolve’s capture window. For the best results, connect an Ultra HD display to your Cintel scanner so that you can monitor at the maximum available resolution while you focus.

With Focus Assist turned on, focus peaking will detect the film grain of the scanned image whenever the film plane is in perfect focus. This enables the operator to focus the scanner even if the film image is out of focus. Simply monitor the Ultra HD output of the scanner while you turn the Cintel scanner’s focus wheel. Your image will be in focus when the grain running throughout the image displays peaking outlines.

You can verify the focal adjustments you’ve made by checking the edges of your film’s perforations. When these are sharp, your film will be in focus.

Reset the Timecode

To set the timecode for the roll of film you’re about to scan, you need to locate the zero frame for that roll. It’s standard practice to punch a small physical hole within the frame before the first frame of necessary film on a roll, to use as a permanent reference for whenever that roll is scanned. This is referred to as the marker frame, lab roll hole, or head punch. By always setting the first frame of timecode to match the marker frame, subsequent film scans will have the same frame count as previous scans, making it possible to rescan and reconform the same material whenever necessary.
To reset scanned timecode at the marker frame of a new film roll:

1. Use the transport controls under the viewer to locate the marker frame.

2. Click the ‘viewer’ option menu and choose ‘current frame timecode.’

3. Enter a timecode value in the dialog box that appears. For example, if you’re scanning the first roll of a project, you can enter 01:00:00:00.

4. When you’re done, click OK.

Timecode cannot be a negative value, so don’t set the start frame to zero. Another common organizational technique is to change the hour number whenever you change rolls, to coincide with the film roll’s number, which makes it easy to identify a scanned clip with the corresponding source roll and frame range.

Your Cintel Scanner has built in ‘Options Interface’ ports for adding optional hardware in the future. This offers the ability to add optional features such as reading KeyKode from the camera negative, or optical/magnetic audio. For more information, see the ‘Optional Audio and KeyKode Reader’ section.

Choose a Location to Save the Scanned Frames

Once all this is done, scroll down to the ‘capture info’ controls in DaVinci Resolve’s film scanner panel, and click the ‘browse’ button to choose a location for the scanned files. You can use the other fields in this section to set what prefix you want to add to the name of the scanned files and enclosing folders. The ‘file name prefix’ updates the file name preview that’s shown at the top in the header. The header also shows the file path, resolution, frame rate, duration, and the format. Specify what roll, reel, clip, and program information you want associated with the scanned media. The ‘timestamp prefix’ checkbox in the ‘Capture info’ controls is selected by default and will save your clips to independent sub-folders within the destination folder, together with a timecode prefix in the file name.

If you want to save all your clips together in one master destination folder, simply deselect the checkbox.

When you capture an HDR clip, the scanner completes a high exposure scan and saves it in a hidden folder named .HDR inside the same folder as the standard scan. If you delete the .HDR folder, the scan converts to a normal clip after refreshing it in the media storage and re-importing the clip into media pool. This is useful if there is a problem with the HDR portion of the scan, as you can easily convert it to a regular CRI clip.
Check the Codec

DaVinci Resolve selects the ‘Cintel Raw’ codec by default, or you can choose ‘Cintel Raw 3:1’.

The Cintel Raw Format

The Cintel Raw Format Bayer pattern of each film frame scanned with your Cintel scanner’s sensor is saved with embedded scanner metadata as a 12-bit linear Cintel Raw Image, or CRI, image sequence. When grading in DaVinci Resolve, CRI images are automatically debayered as 12-bit log encoded image data.

The logarithmic encoding is similar, but not identical to Cineon encoding. For example, negative film is encoded using a Gamma of 2.046 for density, while print film is encoded using a full range Gamma 2.2 curve to ensure that no image data is clipped. Both of these logarithmic encodings can be converted to a linear color space using the ‘Cintel to Linear’ 1D LUT, before converting to other color spaces you may want to work in.

The film is scanned using the full sensor aperture of 4096x3072 to keep the audio waveform visible for optical audio and to accommodate perforation visibility for stabilization. The image is then cropped and the resolution of the capture files depends on the source film format after overscan for perforations and the audio area are removed. For more information about scanning resolutions for different types of film, see the ‘specifications’ section.

The Cintel scanner creates Cintel Raw files with variable bitrate lossless compression by default. This is visually lossless compression and achieves approximately 3:2 reduction in file size depending on image content. However, Cintel Raw 3:1 uses lossy compression with a ratio of approximately 3:1. This is still very high quality but may not always be visually lossless. For example, files for 35mm 4 perf are approximately 12.5MB with Cintel Raw and approximately 6.3MB with Cintel Raw 3:1. Files for 16mm are approximately 4MB with Cintel Raw and approximately 2MB with Cintel Raw 3:1.

CinemaDNG Quality Settings

To control the quality of CRI files, use the ‘decode quality’ and ‘play quality’ CinemaDNG settings located in the Camera Raw panel of the project Settings. These settings are ‘full’ by default. On computers with low processor or memory resources, these settings may be lowered but this will affect the quality of the final render.

Set the Timeline Resolution

DaVinci Resolve displays and renders the output from the scanner using the same resolution as the timeline. For example, for 35mm 4 perforation film, a custom resolution of 4096x3072 would be required for maximum resolution.

For more information on the cropped image area resolutions for all film gauges, refer to the ‘effective resolutions’ in the ‘specifications’ section. Alternatively, for the full native resolution of the captured clip, access the ‘clips attributes’ in DaVinci Resolve.

Adjusting the Color of the Scanner

DaVinci Resolve’s film scanner panel gives you control over the exposure and color temperature of the light used to illuminate the film for scanning. You can adjust these via the light source master wheel and RGB controls, in order to maximize the amount of information you’re extracting from each frame, while preventing any part of the image from being irretrievably clipped. While it’s true that CRI is a raw image format, there’s no latitude beyond the internal data range used by DaVinci, so be mindful that if you’re clipping data in the built in video scopes while scanning, it might be clipped permanently in the scanned media.
How often you’ll adjust the color and exposure of scanned shots depends on how much variety there is in the scenes on a particular film roll. For example, some rolls may have many takes of the same scene, all of which have the same lighting and which can share the same adjustments.

Meanwhile, other rolls may have a variety of different scenes with widely different lighting in each one, necessitating you to make individual adjustments for each scanned clip to maximize data quality.

This is important because the light source master wheel and RGB controls cannot be automatically changed between scanned clips in a log and capture workflow. This means that the current light source settings will be used for all clips you scan until you manually change those settings again, even for clips that you’ve logged from different parts of a film roll. This means that the log and capture style of working is only advisable in situations where it makes sense to log multiple clips that share the same light source master wheel and RGB control adjustments.

Otherwise, it’s recommended you make lighting adjustments on a clip by clip basis, as you scan each clip, in situations where you need maximum image quality for finishing. Keep in mind that the goal for these adjustments is to maximize image data from the scan, not to create the final look of the clips, which you’ll accomplish later in the grading phase of work using the controls of the ‘color’ page.

To adjust the light source settings, find a typical image for the section of roll or for the first series of shots you’re going to scan, and adjust the light source while viewing the built in video scopes.

Adjust the light source master wheel to set the intensity of the light source used to illuminate the film, raising or lowering the level of the R, G, and B channels all at once. For a typical camera negative, this lets you adjust the black point of the film image. In a negative print, the darkest part of the image corresponds to the highlights of the film image. Set the light source master wheel to sit just above the typical Dmin value of 95, as measured on the histogram of the video scopes, which guarantees that the highlights won’t be clipped by the Cineon LOG conversion that DaVinci uses to debayer the CRI image for grading. For positive film, simply adjust light source so that no part of the highlights or shadows of the signal is being clipped.

You can turn on ‘show reference levels’ in the waveform, RGB parade, or histogram scopes, and set the ‘low’ value to indicate the digital Dmin value of 95.

Once that’s accomplished, adjust the RGB controls to rebalance all three color channels by varying amounts to alter the color temperature of the light source used to illuminate the film, to produce the most useful, or neutral, color balance in the scanned result.

Scanning One or More Sections of Film

After you’ve adjusted the light source, it’s a good idea to stay organized as you scan each clip by entering all relevant metadata into the metadata editor as you go. The ‘capture info’ group of metadata fields contains information for defining the file name prefix, roll, reel number, clip number, program name, flags, and whether a particular take is good. If you populate these fields before scanning a clip, that metadata will be written into the clip.

At the bottom of the ‘capture info’ panel, you will see four buttons for film scanning.

With all of this accomplished, you can scan the film in one of four ways:

- **Capture Now**: Use the capture now button to capture long sections of a reel all at once. Clicking ‘capture now’ begins scanning near the current frame, ending whenever you click ‘stop’.

  If ‘Enable 2 Pass HDR Scan’ is selected, click ‘Capture HDR’ after the capture has begun to let DaVinci Resolve know you’ve reached the end of your desired clip so it can now proceed to capture the high exposure pass. If you scan the entire reel without clicking ‘Capture HDR’, the scanner automatically proceeds with the high intensity scan from where you started it until the end of the reel.
– **Capture Clip:** A more controlled means of scanning specific sections of film. After you’ve used the transport controls and the In and Out button to define a section of film, clicking ‘capture clip’ scans that one clip and then stops.

If ‘Enable 2 Pass HDR Scan’ is selected, the high intensity HDR scan uses the same In and Out points as the initial scan.

– **Batch Clips:** A way you can log multiple clips in advance of scanning them all at once using the current light source settings in DaVinci Resolve’s film scanner panel. Log each clip in advance by setting In and Out points for each section of film you want to scan, and click the ‘log clip’ button to save that frame range as an unscanned clip in the media pool. When you click ‘batch clips’, all unscanned clips will be scanned one after the other until the job is complete. You can also select one or more unscanned clips, and only the selected clips will be scanned. Furthermore, you can import an EDL that corresponds to a particular film roll, and use the resulting logged clips for scanning.

**NOTE:** When you click the ‘log clip’ button, Cintel Scanner applies the same project settings to all clips in the batch, and uses the newest project settings at the time of capture. You are advised to confirm the scanner settings before starting the batch capture.

If ‘Enable 2 Pass HDR Scan’ is selected, the high intensity HDR scan uses the same sets of In and Out points as the initial batch of scans.

For more information on batch capture workflows, see Chapter 23, “Ingesting From Tape.”

– **Snapshot:** Capture a single frame with normal exposure and current scanner settings.

Once scanning, if DaVinci Resolve detects that your storage bandwidth is too low to capture at the selected speed, the scan speed will automatically adjust to ensure the capture is successful. If you are using the optional Audio and KeyKode Reader accessory, the audio sample rate will also be adjusted to maintain your chosen audio quality.

### Extracting Audio

If the film you’re scanning also contains an optical sound track, you can extract the audio in a separate step. There is a standard image frame to audio frame offset of 26 frames for 16mm and 21 frames for 35mm that DaVinci automatically aligns when extracting the audio. Select all of the clips that have an optical sound track, then right-click one of the selected clips and choose ‘extract audio’. Resolve analyzes the overlapping optical track area of each frame and automatically generates a matching audio track, synchronized with the scanned image sequence.

Each clip’s audio will be automatically extracted, embedded in the clip and saved to the same directory the scanned frames have been written to. A small audio icon will appear on the corner of your clip’s thumbnail so you know there is a corresponding audio file.

To make extraction easier, you can filter the clips in the media storage by name, resolution, date modified or by film clips only. Filtering your clips makes it easier for you to find and select exactly what you need. You can also make a large selection and extract audio from multiple clips at once by right clicking on your selection and choosing ‘extract audio...’ from the menu. During audio extraction, an information box indicates the progress. You can click the ‘stop’ button any time to stop the extraction.
You can filter the contents in the media storage to make it easier to manage them.

If the ‘timestamp prefix’ checkbox was deselected in the ‘capture info’ section when your clips were scanned, and you want to have extracted audio automatically embedded in your clips, always remember to extract audio from the clips inside the media pool.

**Audio Extraction Settings**

Normally, once you have selected the film type, the automatic features in DaVinci Resolve will extract your optical audio perfectly. However, the condition of the optical track can vary with the condition of the film being loaded and in some instances this can confuse the automation. If this happens, you can bypass the automatic features and make adjustments manually.

For manual adjustments, simply open the ‘Audio Extraction’ settings window by clicking on ‘Show Cintel Audio Settings’ in the inspector options near the top right of the viewer.

The Audio Extraction settings let you make manual adjustments, if needed.
Audio extraction settings let you make the following manual adjustments:

**Show audio scan area**
This checkbox turns the audio scan area guides on or off. The guides are displayed as a box on the side of the frame covering the optical audio scan area and shows what optical information will be used during extraction. The position of the guides will conform to the film type you have selected. However, you can change the position manually if you need to. The audio scan area guides are also great indicators to show you what is happening during the extraction process so you can identify any potential troubles and make manual adjustments.

Inside the box is a thin red line. This line is the mid point detector which detects the separation between stereo audio channels. When mono sound is detected during audio extraction, the mid point detector disappears and the guides will adjust automatically to suit the width of the mono optical track.

**TIP** If you need a closer inspection of the audio scan area guides, you can zoom into the viewer and move the viewer position up or down, and left or right. Simply choose the amount of zoom from the sizing options at the top left corner of the viewer, then click and drag the viewer with your mouse or track pad.

When ‘show audio scan area’ setting is turned on, the audio area guides will be visible so you can see exactly what information is being used and monitor the extraction process.

**Override audio scan area**
This setting provides sliders for adjusting the horizontal and vertical positioning, width, and height of the audio scan area guides.

These settings include:

– **Left and Width**: If your film type is such that audio appears on the right side of the frame, you can simply adjust the ‘left’ slider to move the guide box to the right. Normally, this will happen automatically if you have the corresponding film type selected, but the setting gives you more flexibility for adjustments if you need it. Similarly, the ‘width’ setting is used to adjust the width of the scan area.

These are helpful tools for making subtle adjustments to the side edges of the guide box if there are unwanted elements inside the film’s optical audio area. This can happen due to perforation...
wear and tear, or varying print qualities, and can sometimes interfere with the quality of the audio extraction. You can help avoid this by making a subtle movement to the side edges to keep the stray elements outside of the guide box.

- **Top**: This setting adjusts the vertical position of the guide box.
- **Height**: Sometimes film frames on older rolls of film may be slightly smaller than normal due to shrinkage over time. When making manual adjustments to the guide box, you can make adjustments for film shrinkage using the ‘height’ slider.
- **Auto adjust audio scan height**: This setting is on by default and automatically adjusts the guide box height to align with the audio waveform at the top of each frame. The automatic feature works well for normal audio conditions, however, if during extraction you notice the box moving randomly and the quality of the extraction is affected, it may be due to similar features in the audio track overlapping between frames. If this occurs, deselect the checkbox and try the extraction again.

If deselecting the ‘Auto adjust audio scan height’ checkbox, make sure the ‘height’ setting places the guide box at the optimal position for the frame. Making manual adjustments can help if you need them, but don’t forget to turn the automatic features back on afterwards!

- **Audio waveform color is white**: Depending on the scanned film type, the audio waveform may be black or white. If the waveform is white, make sure the corresponding checkbox is enabled. This will ensure the white information in the waveform is used during audio extraction. If the waveform is black and the surrounding audio area is white, disable the checkbox so DaVinci knows to use the black information in the waveform. Other automatic features, such as mid point and mono detection, also rely on this setting being set correctly.

- **Override firmware stability**: In rare instances, the condition of the film may have created large movements in the frame due to the internal firmware stabilization. This can cause the audio extraction guide box to misalign with the optical track. If this occurs, enabling ‘override firmware stability’ lets the audio extraction guide box track the film perforations independently and adjust its positioning for potentially better results.

- **Variable density audio**: If your film contains variable density audio, make sure you select the ‘Variable density audio’ checkbox so DaVinci Resolve knows the type of audio to extract. The default state is set to ‘off’ for variable area audio soundtracks.

If you haven’t used variable density audio before, you can visually identify it as a tight sequence of shaded lines, similar to a bar code with the lines squeezed closer together. By comparison, ‘variable area’ soundtracks appear as an audio waveform.

### Color Space and Sizing

A pair of 1D LUTs, ‘Cintel Negative to Linear,’ and ‘Cintel Print to Linear,’ have been provided to help you convert scanned media to a color space in which you can do further work. You can apply these LUTs via a node in the ‘color’ page to convert the original scans to a Linear color space. However, if you want to convert the image to Rec. 709 or to Cineon for further adjustment, you’ll want to apply a second LUT in a second node. The default color space for print is a 2.2 gamma standard log curve, and all others are 2.046 film density log gamma.

In general for negative film, it’s best to “color invert” after the second LUT is applied. Furthermore, normally some grading is required on the Linear data to remove black offsets, due to Dmin, for proper conversion into the destination color space. There are a variety of VFX IO LUTs available in the 3D LUT submenu of each node’s contextual menu that let you convert an image from Linear color space to any other color space you want to work within.
Using three nodes to convert a film scan using LUTs; node 1 converts from Negative or Print to Linear, node 2 converts from Linear to Rec. 709, and node 3, if required, inverts the color.

Applying a LUT within a node will clip any image data falling below 0 and above 1. To prevent clipping, you can use the Lift/Gamma/Gain controls within any node with a LUT applied to adjust your image levels prior to the transform applied by the LUT within that node.

The format of the film you’re scanning and the way the material was originally shot both affect the framing. You can adjust the final framing of your scanned clip by resizing, zooming, stretching, panning, tilting, and more. On the ‘color’ page, open the ‘sizing’ palette and use the ‘input sizing’ mode to create the necessary framing. To save your sizing preferences as a preset, open the menu, select ‘save as new preset’ and enter a name for your preset.

Once you’ve created an appropriate sizing preset for a given type of media, you can apply that preset to multiple film scans all at once, in either the color page or in the media pool using the ‘change input sizing preset’ command, found in the contextual menu of selected clips. For more information on sizing, see Chapter 150, “Sizing and Image Stabilization.”
Chapter 25

Using the Cut Page

The Cut page is a focused environment for fast editing. It’s useful in situations where you need to quickly cut a news segment, build an episode of web content, edit a straightforward program, experiment with multiple arrangements of a scene, or put together a first assembly edit.

The Cut page is also a good introductory editing interface for people who are new to editing, as it presents a streamlined set of tools that are fast to learn and simple to use. Whatever your background, you’ll find the Cut page to be a valuable addition to your editing experience in DaVinci Resolve.

Contents

Overview of the Cut Page 413
Overview of the Cut Page User Interface 413
Customizing the UI 413
Choose Settings Before You Start 414
Timeline Resolution Quick Menu 414
The Media Pool 415
The Viewer 416
Playing Clips and Navigating the Timeline 417
Tools 417
Bypass Color Grades and Fusion 418
Audio Meter 418
The Timeline 419
Upper Timeline 419
Lower Timeline 419
Tracks 420
Gaps 422
Timeline Controls 422
Undo and Redo in DaVinci Resolve 423
Overview of the Cut Page

With the addition of the Cut page, DaVinci Resolve now has two editing environments, intended for two different audiences. While the Cut and Edit pages share many of the same panels such as the Media Pool, the Timeline, and the Viewer, the controls that are exposed on the Cut page have been designed for speed, so you can cut professional programs faster than you’ve ever been able to before.

Overview of the Cut Page User Interface

The default workspace of the Cut page consists of the Media Pool, a single Viewer, and the Timeline area. These three regions let you quickly import and organize clips, edit clips, and even export the result, all from within the Cut page.

Customizing the UI

A User Interface toolbar at the top of the Cut page lets you hide and show different panels as necessary. For example, you can hide the Media Pool if you wanted more room for the Viewer. You can also replace the Media Pool with other browsers in the Media Pool’s default area, showing the Sync Bin, Transitions, Titles, or Effects Browser in order to add those effects to your program in the Timeline. On the right side of the User Interface toolbar you can perform a Quick Export, expand the Viewer to Full Screen, or open the Inspector.

Separate buttons on the left let you open the Media Pool, Sync Bin, Transitions, Titles, and Effects browser.

You can resize the Media Pool and Viewer by dragging the vertical seam that connects them to the left or right, in the process making one panel bigger and the neighboring panel smaller.
You can also resize the Timeline area by dragging the timeline handle (at the upper right corner of the Timeline) up or down, making more or less room for the Timeline while simultaneously resizing the Media Pool and Viewer areas.

Choose Settings Before You Start

When you first create a new project, you need to define its Timeline settings; you can optionally choose from common presets or a fully custom setup.

Timeline Resolution Quick Menu

This drop-down menu, to the top-right of the Viewer, lets you quickly choose which resolution you want to work at. A Custom option lets you open up the Timeline Settings panel in order to choose your own options. For more information about the Timeline Settings, see Chapter 5, “Project Settings.”
The Media Pool

The Media Pool contains all video clips, audio clips, graphics, and other media that you import into your project. You can create bins with which to organize all of this media, to make it easier to find what you need quickly. These bins are opened via the bin drop-down at the upper left-hand corner.

Each piece of media you import, whether it’s video, audio, or graphics, appears as an individual clip and can be selected, scrubbed for fast viewing, reorganized into bins, opened into the Viewer for playback, or edited into a timeline using the edit buttons or via drag and drop.

The Media Pool in Thumbnail view

Three buttons at the upper right of the Media Pool let you see your clips in different ways, depending on what you need to accomplish.

The Viewing Modes buttons

- **Metadata view**: Each clip is represented by its own card with a scrubbable thumbnail and basic clip metadata information visible. This view is designed to have more metadata information than a thumbnail view but more targeted information than the List view.

- **Thumbnail view**: Each clip is represented by a scrubbable thumbnail. Hover the playhead over each thumbnail and move it left and right to see the clip’s image play, and use the I and O keys to mark sections of a clip that you want to use. Clicking on the lower right corner of a thumbnail reveals the clip’s metadata.

- **Filmstrip view**: Each clip is represented by a filmstrip of consecutive frames the length of the Media Pool. Hover the playhead over the clip and move it left and right to see the clip’s image play, and use the I and O keys to mark sections of a clip that you want to use.

- **List view**: Each clip appears as an item in a multi-column list showing a variety of metadata about each clip. In List view, you can click the header of any column to sort the contents by that column’s information (clicking again toggles the sort order between Ascending and Descending). Scrolling right reveals additional columns of information.
A Sort Media By drop-down menu lets you choose which criteria defines the order in which clips in the Media Pool are arranged. Options include: Bin, Timecode, Camera, Date Time, Clip Name, Scene Shot, Clip Color, Date Modified and Date Imported, and you can choose to sort in Ascending (bottom to top) or Descending (top to bottom) order.

Lastly, a search field lets you type a term you want to use to find one or more clips that match that criteria. When you type anything, the contents of the Media Pool shrink to show only clips that match your criteria.

The Viewer

The Viewer lets you see clips from the Media Pool, or clips in the Timeline, and has numerous controls to control what you see and how things play.

The Viewer has four mode options. Which option is currently in use can be seen, and switched, by four buttons in the upper lefthand corner of the Viewer.
The Viewer modes buttons

The Different options are entered automatically by various actions (from left to right):

- You can double-click any clip to open it into the Viewer as a Source Clip.
- You can view an entire bin full of clips in the Source Tape.
- You can play your edited program in the Timeline.
- You can select various framing guides and safe areas for the Viewer.

Playing Clips and Navigating the Timeline

Eight controls sit at the bottom of the Viewer. These let you play through and otherwise navigate clips and the Timeline in different ways. These controls are described from left to right.

- **Fast Review button:** Intended to help you watch through a large collection of media quickly, clicking this button begins accelerated playback through the Source Tape or through the Timeline, where the speed of playback is relative to the length of each clip you’re playing through. Long clips play faster, whereas shorter clips play closer to real time. In this way, you can watch a lot of material really quickly.
- **Tools button:** The Tools button reveals a variety of controls for transform, crop, audio, speed effects, camera stabilization and lens correction, dynamic zoom, and compositing, covered in more detail later in this chapter.
- **Jog control:** Clicking and dragging within the jog control lets you scrub very precisely through the content of the Viewer.
- **Transport controls:** A set of Previous Edit (Up Arrow), Stop (Spacebar), Play (Spacebar), Next Edit (Down Arrow), and Loop Playback (Command-/) buttons constitute clickable controls for controlling playback of clips and the Timeline. Each button has a matching keyboard shortcut.
- **Mark In/Out:** Clickable controls to set In and Out points respectively.
- **Playhead timecode:** A number field shows you the timecode value at the playhead of a clip or of the Timeline to give you a numeric reference for where you are.

Tools

Clicking the Tools button reveals a toolbar that you can use to add and edit clip effects, right within the Viewer with no Inspector needed. The Tools button reveals a variety of controls for transform, crop, audio, speed effects, camera stabilization and lens correction, dynamic zoom, and compositing, covered in more detail later in this chapter.
Bypass Color Grades and Fusion

The Bypass Color Grades and Fusion Effects button/drop-down lets you turn off all grades and effects that you may have applied in the Color page and/or Fusion page in order to improve playback performance on low power computers. Click the button (Shift-D) to disable or reenable grading and effects, or right-click this button to access a menu that lets you choose which things you want this button to control.

Audio Meter

An audio meter to the right of the Viewer shows you a graphical representation of the audio levels playing in the current clip or in the Timeline as you play through the Viewer, via animated vertical bars that are tinted to indicate how loud the levels are:

- Green indicates safe levels
- Yellow indicates levels that are peaking at approximately safe levels
- Red indicates levels that may be peaking at levels that are too high, risking clipping the signal and causing distortion

These animated bars serve as a visual reference you can use to help you adjust the volume of different clips to create a pleasing balance, and to make sure you don’t exceed the maximum desired level and introduce clipping. A speaker button at the top of the meters lets you mute or unmute audio playback.
The Timeline

The word “timeline” refers both to an edited sequence of clips, which constitutes a program that is stored in the Media Pool, and to the area of the Cut page interface where you can open this sequence of clips to see its contents, and for playback and editing.

Timelines are created and stored in the Media Pool, along with all of your other clips. However, each timeline is assembled and edited in what is sometimes referred to as the Timeline Editor. Different pages of DaVinci Resolve show your timeline differently according to the special requirements of each page focusing variously on different methods of editing, grading, compositing, and audio. However, while the interface of the Timeline Editor changes from page to page, the actual contents of the Timeline are identical, because each page’s Timeline Editor is in fact showing the exact same Timeline that is currently open. This means that the advanced user can use every page of DaVinci to do different things to the same Timeline, with only the interface changing to make different functions possible in different pages.

For the Cut page user, the Timeline is divided into an Upper Timeline at the top, and a larger and more detailed Timeline Editor showing a zoomed in portion of the Timeline around the playhead at the bottom. Working together, these two views of your edited sequence make it possible to navigate your entire project and cut in great detail.

Upper Timeline

The Upper Timeline always shows the entire program within the full width of your computer’s display. The Upper Timeline’s playhead is always free, which makes it easy to use your pointer to scroll around the entire program by dragging within the Timeline Ruler at top. This also serves as a visual reference for keeping track of where you are in your program while you’re editing within the zoomed-in Lower Timeline below.

Despite the Upper Timeline’s relatively small size, you can still edit in it, with most editing and trimming functions that are available in the Lower Timeline also available in the Upper Timeline. Most interestingly, it’s also possible to drag clips from one part of your program in the Lower Timeline, to another area of your program in the Upper Timeline, and vice versa.

A set of small numbers to the left of the Upper Timeline lets you click a number to choose the currently selected track; this selection is mirrored on the zoomed in timeline below. The currently selected track affects where incoming clips will be placed when editing, among other things.

Lower Timeline

The zoomed in Lower Timeline (often referred to simply as “the Timeline”) shows you a close-up view of the portion of the currently open timeline that immediately surrounds the playhead. The zoom level is fixed; you cannot change it. The zoomed-in lower timeline is intended for detailed editing, but clips can be dragged between the Timeline and Upper Timeline for fast reordering of clips across the entire duration of your program.
Locked or Free Playhead
A pair of buttons at the upper left-hand corner of the Timeline lets you choose whether you use a locked or free playhead.

Two buttons let you choose to use a locked or free playhead.

– When set to locked, the playhead is fixed in the center of the Timeline, and your edited clips scroll past it as you play (press the Spacebar), jog, or shuttle (use the JKL keys) in either direction. Locked mode works great when you use the DaVinci Resolve Editor Keyboard. You can also scroll the Timeline using your pointer by dragging the Timeline Ruler at the top to the left or right, which also drags all of your clips to the left or right.

– When set to free, the playhead moves across the clips as you play (press the Spacebar), jog, or shuttle (use the JKL keys) in either direction; the clips stay still. Once the playhead gets to the right or left edge of the Timeline, the Timeline pages over to reveal the next part of your edit. You can also move the playhead by clicking in the Timeline Ruler to jump the playhead to that frame, or by positioning the pointer over the playhead’s top handle, or over the playhead itself, and dragging the playhead wherever you want it to go.

Tracks
The Timeline is divided into multiple tracks, with each track capable of holding a sequence of clips in order to create a program. The main tracks, which are labeled numerically, combine a clip’s video and audio into a single item in the Timeline, for simplicity. Editing the In or Out point of a clip edits the video and audio together.

Track 1 shows combined Video+Audio tracks in the Cut page Timeline.

**TIP:** In the Edit page, Video+Audio clips are presented as separated Video and Audio items on different tracks. When you open the Fairlight page, audio is presented on tracks with lanes, where each audio channel can be seen. In this way, each page gives you different sets of controls over the contents of the Timeline that are appropriate for each page.
Track Header Controls

Separate Lock Track, Audio Mute, and Video Enable buttons in each track’s timeline header let you separately Lock and enable or disable the audio and/or video of every clip on that track.

The Importance of Track 1

Each track in the Timeline of the Cut page is designed to carry specific parts of your program. Track 1 is intended for the primary video+audio of your program, often called the “A-roll,” since these are the primary shots comprising the timing and pacing of the story you’re telling. Adding, deleting, inserting, trimming, or otherwise rearranging clips on Track 1 results in the rest of the edited timeline being automatically rippled to accommodate the change you’ve made, with clips to the right of the changed area moving left to fill the gap of a deleted or shortened clips, or moving right to make room for an inserted or lengthened clip.

Tracks 2 and Above

Tracks 2 and above are intended for “B-roll,” which is additional footage you stack on top of other clips in Track 1 to illustrate what someone is saying in the audio of Track 1, or for superimpositions used for compositing effects that combine two images together in creative ways. Moving or resizing clips on Track 2 and above only moves or resizes that one clip; other clips in the Timeline are not rearranged and the Timeline is not rippled when you do this.

For instances where multiple video clips overlap one another on multiple tracks, the video clip on the highest track obscures those on lower tracks, meaning that only the top clips appear during playback. This is useful when you’re experimenting with rearranging multiple clips in a complex scene. For example, you could be editing a scene where an interview clip is on the bottom track, and various b-roll clips are edited on tracks above the interview so you can freely rearrange them in different ways, while it’s always easy to reveal the speaker on the bottom track by leaving a gap in the superimposed b-roll clips.

However, if you superimpose video-only or video+audio clips for compositing, you can use the composite modes and the opacity slider found in the Composite section of the Viewer Tools controls to mix multiple images together in different ways for artistic effects.
You can add additional Video+Audio tracks, when necessary, by either dragging a clip to the undefined gray area of the Timeline above the other existing tracks to make a new track automatically, by clicking the New Track button at the upper lefthand corner of the Timeline, or by right-clicking in the timeline header area and choosing “Add Video Track” from the contextual menu.

Audio-Only Tracks
You can also edit audio-only clips such as music, narration, or sound effects, onto separate audio-only tracks underneath, which are then labeled A1, A2, A3, etcetera. If you drag an audio clip to the undefined gray area of the Timeline below the other existing tracks, an audio-only track will automatically be created.

Gaps
Because Track 1 is meant to hold the principal clips for your program, the Timeline automatically rearranges itself to close gaps that would otherwise result when you move or rearrange clips in Track 1, and superimposed clips in Tracks 2 and above move to keep in sync with the clips they’re superimposed over. However, you can move superimposed clips on Tracks 2 and above to place them wherever you want, and gaps will be left between multiple clips on the same superimposed track so they can be edited at specific places.

Timeline Controls
Other buttons at the upper lefthand corner of the Timeline let you enable/disable Snapping that helps you align clips you’re dragging in the Timeline with one another, toggle for an enhanced audio trim mode, create Markers that let you keep track of important frames of the Timeline, and add new tracks to the Timeline.
Undo and Redo in DaVinci Resolve

No matter where you are in DaVinci Resolve, Undo and Redo commands let you back out of steps you’ve taken or commands you’ve executed, and reapply them if you change your mind. DaVinci Resolve is capable of undoing the entire history of things you’ve done since creating or opening a particular project. When you close a project, its entire undo history is purged. The next time you begin work on a project, its undo history starts anew.

Because DaVinci Resolve integrates so much functionality in one application, there are three separate sets of undo “stacks” to help you manage your work.

– The Media, Edit and Fairlight pages share the same multiple-undo stack, which lets you backtrack out of changes made in the Media Pool, the Timeline, the Metadata Editor, and the Viewers.

– Each clip in the Fusion page has its own undo stack, so you can undo changes you make to the composition of each clip, independently.

– Each clip in the Color page has its own undo stack, so you can undo changes you make to grades in each clip, independently.

In all cases, there is no practical limit to the number of steps that are undoable (although there may be a limit to what you can remember). To take advantage of this, there are three ways you can undo work to go to a previous state of your project, no matter what page you’re in.

To simply undo or redo changes you’ve made one at a time:

– Choose Edit > Undo (Command-Z) to undo the previous change.

– Choose Edit > Redo (Shift-Command-Z) to redo to the next change.

– On the DaVinci control panel, press the UNDO and REDO buttons on the T-bar panel.

You can also undo several steps at a time using the History submenu and window. At the time of this writing, this only works for multiple undo steps in the Media, Cut, Edit, and Fairlight pages.

To undo and redo using the History submenu:

1. Open the Edit > History submenu, which shows (up to) the last twenty things you’ve done.

2. Choose an item on the list to undo back to that point. The most recent thing you’ve done appears at the top of this list, and the change you’ve just made appears with a check next to it. Steps that have been undone but that can still be redone remain in this menu, so you can see what’s possible. However, if you’ve undone several changes at once and then you make a new change, you cannot undo any more and those steps disappear from the menu.
Once you've selected a step to undo to, the menu closes and the project updates to show you its current state.

**To undo and redo using the History window:**

1. Choose Edit > History > Open History Window.

2. When the History dialog appears, click an item on the list to undo back to that point. Unlike the menu, in this window the most recent thing you've done appears at the bottom of this list. Selecting a change here grays out changes that can still be redone, as the project updates to show you its current state.

3. When you're done, close the History window.
Before you can start editing, you need to import the clips you want to use for your program into the Media Pool, which is the central repository of clips in your project. This can include video, audio, and graphics files in any format that’s supported by DaVinci Resolve.

Once imported, the Media Pool on the Cut page has many organizational tools you can use to make your project’s media faster for you to access and sort through as you find the clips you need to create your program.

Contents

Importing Media 426
Removing Media 427
Organizing Media into Bins 427
Master Bin 427
Creating and Using Bins 427
Opening Bins 428
Create Bin With Selected Clips 428
Renaming Bins 428
Import and Export Specific DaVinci Resolve Project Bins 428
Import and Export Individual DaVinci Resolve Timelines 429
Importing ATEM Mini Pro ISO Projects 430
Relinking Camera Masters to ATEM ISOs 430
Importing Media

Two Import buttons at the top of the Media Pool let you use import dialogs to select media you want to bring into the Media Pool for use in your project.

The Import Media and Import Folder buttons

To import individual clips:
1. Do one of the following:
   a. Click the Import Media button.
   b. Press Command-I.
   c. Right-click the Media Pool and choose Import Media.
2. Use the Import dialog to select one or more clips to import, and click Open.
3. If you're prompted to change the frame rate of a currently empty project to match that of the incoming media, click Change.

Each piece of media you import, whether it's video, audio, or graphics, appears as an individual clip in the Media Pool. You can also import an entire folder full of media as a bin in the Media Pool.

To import a folder full of media into a bin:
1. Click the Import Media Folder button.
2. Use the Import dialog to select a folder containing media you want to import, and click Open.
3. If you're prompted to change the frame rate of a currently empty project to match that of the incoming media, click Change.
Each folder you import appears as a bin in the Media Pool. Double-clicking a bin opens its contents into the Media Pool, enabling you to view each individual clip.

Tip: For additional media import features, you can use the Media page, with its Media Storage browser and more feature-rich version of the Media Pool.

Removing Media

If there are clips you no longer want in your project, you can simply select them and press the Delete or Backspace keys. A Dialog asks if you want to remove the selected clip or clips; clicking Remove will remove them from the Media Pool, while leaving them intact on your media storage device.

If you want to remove every clip in the currently open bin (even the Master bin), you can also right-click anywhere within the Media Pool and choose Remove All Clips in Bin from the contextual menu.

Organizing Media into Bins

For short projects, having all your clips together in a single bin (the Master bin is the top level of the Media Pool) can be fast. However, for longer projects, organizing your media into subsets of clips within individual bins can make browsing each bin’s contents using the Source Tape of the Viewer more manageable.

Tip: You can move clips you know you don’t want, such as instances where the camera rolled on unusable scenery or moments, or completely unusable takes, into another bin so those clips don’t present themselves in the Source Tape for bins containing clips you want to use.

Master Bin

At the top level of your project hierarchy is the Master bin. The Master bin contains all of the media content (clips, timelines, graphics, other bins, etc.) for your project. In the Cut page, the Master bin also shows all of your project’s timelines for easy access, regardless of where they’ve been created in your project.

Creating and Using Bins

You can create bins with which to organize your media by choosing File > New Bin (Shift-Command-N), or by right-clicking in the Media Pool and choosing New Bin from the contextual menu. You can create bins inside of other bins, and in so doing hierarchically organize the clips you need in a variety of ways.

Bins seen in the Media Pool

Once you’ve created a bin, you can move one or more selected clips into it via drag and drop, just as you would on the desktop of your operating system’s file manager.
Opening Bins

Any visible bin in the Media Pool can be opened by double-clicking it, or by clicking the Bin drop-down at the upper left-hand corner of the Media Pool and choosing a bin to open from the menu (they’re shown as a hierarchical list). When opened, a bin’s contents fill the Media Pool, and a path indicator at the top of the Media Pool lets you see how many levels deep you are in cases where you have bins inside of bins. You can click any level of this path to jump back up the hierarchy, or you can choose another bin from the Bin drop-down.

Create Bin With Selected Clips

You can also create a bin and put clips into it in one step. Select one or more clips in the Media Pool, right-click one of the selected clips, and choose Create Bin With Selected Clips from the contextual menu. A new bin appears called “Bin X” (where X is the next number that’s available) displaying the selected clips it now contains.

Renaming Bins

To rename a bin, click its name once, then slowly click a second time (clicking too fast is a “double-click” which opens the bin), and the name becomes highlighted, ready for editing. You can also right-click a bin and choose Rename Bin from the contextual menu, which also highlights the bin’s name, ready for editing. When you’re done typing a new name, press Return (or Enter).

Import and Export Specific DaVinci Resolve Project Bins

You can import/export specific bins from one DaVinci Resolve project to another, allowing you to pass bins quickly between projects and workstations that have access to the same media. All Metadata, In/Out points, Timelines, etc. are transferred along with the clips in the bin, but none of the actual media files are included.

**To export bins from the Media Pool:**

1. Select one or more bins in the Media Pool.
2. Right-click the selection and choose “Export Bin,” or choose File > Export > Export Bin.
3. Choose where to save the DaVinci Resolve Bin file (.drb) in the file system dialog, and click Save.
To import bins into the Media Pool:
1 Right-click in the Media Pool and choose “Import Bin,” or choose File > Import > Import Bin.
2 Do one of the following:
   – Choose a DaVinci Resolve Bin file (.drb) from the file system dialog.
   – Double click the .drb file in your file system.

The bin or bins will appear in the Media Pool. Any bins imported this way will have the word “import” appended to their name, to avoid duplicate names. If you import a bin that contains clips that were already in the Media Pool, the potentially duplicate clips are excluded from the import and instead relinked to the media referenced by your project. This keeps your Media Pool tidy. However, if the bin or bins have been moved to another computer, you may have to relink offline media.

Import and Export Individual DaVinci Resolve Timelines
You can export and import individual timelines from one DaVinci Resolve project into another previously existing DaVinci Resolve project, allowing you to pass timelines quickly between projects and workstations, without creating additional imported project files. Just the timeline and its associated clip information is exported, none of the actual media files are included.

To export a timeline from the Media Pool:
1 Select a timeline from the Media Pool.
2 Choose File > Export > Export AAF, XML, DRT (Shift-Command-O).
3 Choose “DaVinci Resolve Timeline Files (*.drt)” from the format options drop-down in the file system dialog.
4 Choose where to save the DaVinci Resolve Timeline file (.drt) in the file system dialog, and click Save.

To import a timeline into the Media Pool:
1 Choose a bin in the Media Pool in which you want the imported timeline to be saved.
2 Do one of the following:
   – Choose File > Import Timeline > Import AAF, XML, DRT (Shift-Command-I), then Select a DaVinci Resolve Timeline file (.drt) from the file system dialog, and click Open.
   – Double click the .drt file in your file system.

The timeline will appear in the Media Pool, along with all of the clips associated with it. Any timelines imported this way will have the word “import” appended to their name, to avoid duplicate names. The imported timeline will be automatically conformed to corresponding media that’s already in the Media Pool. However, if the timeline has been moved to another computer, you may have to reimport or relink missing or offline media in to bring the imported timeline fully online.

**NOTE:** Only a single timeline can be imported and exported at a time using this method. To import or export multiple timelines, use the Import/Export Bin function described above.
Importing ATEM Mini Pro ISO Projects

It is possible to import ATEM Mini Pro ISO projects directly into the Cut page. ATEM projects include the master program clip, as well as each individual camera “ISO” (isolated) clip, and each angle’s audio recordings. All transitions, timecode, and camera number metadata are imported, as well as whatever graphics were stored in the ATEM’s Media Pool. Once the project is loaded, the Sync Bin view is enabled in the Cut page, so you can seamlessly continue your multi-camera edit.

To import an ATEM Mini Pro ISO Project:

1. Select File > Import Project.
2. Select the DaVinci Resolve Project file (.drp) in the ATEM project folder, in the file browser.
3. Click on the Open button.

Relinking Camera Masters to ATEM ISOs

It’s also possible to instantly switch your ATEM camera ISOs to the original camera recordings made in a Blackmagic Camera. This workflow enables the highest visual quality and the ability to output in higher resolutions (such as 4K or UHD) than are supported by the ATEM internally.

To relink to camera masters from ATEM ISO recordings:

1. (Before you shoot) Check the “Record in All Cameras” setting in the ATEM software control.
2. (Before you shoot) Check the “ISO record all inputs” setting in the ATEM software control.
3. At this point, record your show as you normally would.
4. Copy all the resulting camera masters from each camera’s memory card to the ATEM project’s “Video ISO Files” folder, and then import the project into DaVinci Resolve.
5. Click the “Show Camera Originals” button in the Cut page Viewer to instantly switch between ATEM ISOs and Camera Masters.
Media Pool Views

Once you've imported some clips into the Media Pool, three controls at the upper right-hand side let you control how they look, depending on what you need to accomplish.

**Metadata View**

In the Metadata view mode, each clip is represented by its own card with a thumbnail and basic clip metadata information visible. This view is designed to have more metadata information than a thumbnail but more targeted information than the List view. This feature, combined with its sort modes, is a powerful way to organize and reorganize your clips in the Media Pool.

**The metadata fields of the Metadata view (from the top down):**
- **Thumbnail**: A scrubbable thumbnail image of your clip.
- **Row 1**: A main description field that is variable and determined by the sort order selection.
- **Row 2**: Start Timecode, Date Created, Camera #.
- **Row 3**: Scene, Shot, Take.
- **Row 4**: Clip Name, Comment.

The strength of the Metadata view is the automatic clustering of your clips in the Source Tape, based on the sort order you choose in the Media Pool Sort By menu at the very upper-right corner of the Media Pool. It is also possible to use these sort options in the Thumbnail, List, and Filmstrip views as well.
Each different sort mode changes the main description field on the card and re-arranges the Source Tape to reflect the selected organization method.

**The sort modes available in the Metadata view are:**

- **Bin:** This mode clusters the clips by bin, changes the main description field to clip name, and orders the list by timecode.

- **Timecode:** This mode clusters the clips by creation date, changes the main description field to creation date and start timecode, and orders the list by timecode.

- **Camera:** This mode clusters the clips by Camera #, changes the main description field to camera # and start timecode, and orders the list by timecode.

- **Date Time:** This mode clusters the clips by day, changes the main description field to creation date and file name, and orders the list by timecode.

- **Clip Name:** This mode clusters the clips by the first letter of the clip name in alphabetical order, changes the main description field to clip name, and orders the list by timecode.

- **Scene, Shot:** This mode clusters the clips by scene, changes the main description field to scene-shot-take, and orders the list by scene-shot-take.

- **Clip Color:** This mode clusters the clips by clip color name, changes the main description field to creation date and start timecode, and orders the list by timecode.

- **Date Modified:** This mode clusters the clips by day, changes the main description field to creation date and file name, and orders the list by the last time the clip was modified by the OS filesystem.

- **Date Imported:** This mode clusters the clips by day, changes the main description field to creation date and file name, and orders the list by the date the clip was added to the Media Pool.

- **Ascending:** Orders the Media Pool from lowest numerical value to highest, and alphabetically from A to Z.

- **Descending:** Orders the Media Pool from highest numerical value to lowest, and alphabetically from Z to A.
The Metadata view with clips sorted by Scene-Shot-Take

The Metadata view with the same clips sorted by Camera

**Thumbnail View**

Each clip is represented by a scrubbable thumbnail. Hover the playhead over each thumbnail and move it left and right to see the clip’s image play, and use the I and O keys to mark sections of a clip that you want to use. Hover scrub can be enabled and disabled using the Media Pool option menu on the Edit page.

The Icon View mode
Filmstrip View

Each clip is represented by a filmstrip of consecutive frames the length of the Media Pool. Hover the playhead over the clip and move it left and right to see the clip’s image play, and use the I and O keys to mark sections of a clip that you want to use.

List View

Each clip appears as an item in a multi-column list showing a variety of metadata about each clip. In list view, you can click the header of any column to sort the contents by that column’s information (clicking again toggles the sort order between Ascending and Descending). Scrolling right reveals additional columns of information.
Sorting and Searching

Once you’ve imported media into your project, searching and sorting controls help you find what you need.

**Searching**

A search field lets you type a term you want to use to find one or more clips that match that criteria. When you type anything, the contents of the Media Pool shrink to show only clips that match your criteria.

**Navigable Clip Paths**

The Media Pool in the Cut page has a navigable title bar that shows a clip's Media Pool hierarchy. As you navigate in the Media Pool, the current clip is highlighted, and its hierarchy will now appear in top of the Media Pool title bar. By clicking directly on bins in this bin path, you can quickly broaden or narrow the scope of the Media Pool, say from Shoot Day to Camera to Card to Clip and vice versa.

![Image of Media Pool title bar showing a clip's Media Pool hierarchy. Clicking directly on these bins will narrow or broaden the scope of the clips in the Source tape.]

**Sort Media By**

A Sort Media By drop-down menu lets you choose which criteria defines the order in which clips in the Media Pool are arranged. Options include: Bin, Timecode, Camera, Date Time, Clip Name, Scene Shot, Clip Color, Date Modified, and Date Imported, and you can choose to sort in Ascending (bottom to top) or Descending (top to bottom) order.

![Image of the Sort Media By drop-down menu]
Lastly, a search field lets you type a term you want to use to find one or more clips that match that criteria. When you type anything, the contents of the Media Pool shrink to show only clips that match your criteria.

**TIP:** If you want to sort by a criteria that’s not in the drop-down menu, you can switch the Media Pool to List view, then sort by any column you might want (such as “Date Created”), and then switch back to Icon or Filmstrip view.

**Finding Timeline Clips in the Media Pool**

From time to time, you’ll find yourself wanting to find the source clip in the Media Pool that corresponds to a clip in the Timeline. For example, you might want to go back to a part of an interview clip you’ve already used to find another phrase on the same topic.

**To find a timeline clip in the Media Pool:**

– Right-click a clip in the Timeline, and choose Find in Media Pool from the contextual menu. The corresponding clip is selected in the Media Pool, which scrolls to show that clip, if necessary.

**Clip Color**

Clip colors are an organizational tool that make it easier to keep track of different kinds of clips visually. For example, you can assign colors based on good takes, based on characters or subjects in the program, based on type of media (b-roll versus a-roll for example), or using any one of a number of organizational strategies. Whatever helps you keep track of things you need to keep track of.

**Changing clip colors:**

– You can assign colors to clips by right-clicking one or more selected clips in the Media Pool or Timeline, and choosing one of 16 available colors from the Clip Color submenu of the contextual menu.

**Removing clip colors:**

– Clip colors can be removed by right-clicking one or more selected clips in the Media Pool or Timeline, and choosing Clear Color from the Clip Color submenu of the contextual menu.

– Clip colors appear as a colored dot on a clip thumbnail when in Thumbnail view, as a clip color in Filmstrip view, and as a patch in the Clip Color column when in Column view.
– Clips with assigned colors also appear tinted in the Timeline, similarly to the Filmstrip tint in the Media Pool.

Generate Optimized Media

If you’re editing processor-intensive source formats such as camera raw, H.264, or 8K media, and your computer isn’t fast enough to work with it easily in real time, you can create pre-rendered, low-overhead duplicate media to use instead, that’s automatically managed alongside the original media. This is called “Optimized Media.” Optimized Media lets you work more quickly by allowing you to edit with a more processor-efficient media format and resolution, while providing the ability to easily switch your project back to the original source media whenever you want. So, you can use optimized media to edit, and switch back to the original source media when it’s time to finish and output. Switching is as easy as choosing Playback > Use Optimized Media if Available to toggle optimized media on and off.

DaVinci Resolve automatically manages the relationship between source clips and the optimized media you create, so all you need to do is choose which clips to make optimized media for. For example, if you’re editing a project that consists of half camera raw media, and half DNxHD media, you only need to optimize the camera raw media, so you can use the search field to find all the raw clips you’ve imported based on Resolution, Codec, File Name, or whatever other metadata is appropriate.

To create optimized media:

1. Select one or more clips in the Media Pool that would benefit from being optimized.
2. Right-click one of the selected clips, and choose Generate Optimized Media from the contextual menu.

By default, all optimized media is written to the same directory as the cache files are written, which defaults to the first scratch disk listed in the Preference dialog’s Media Storage panel. The location of cache and optimized files is also selectable via the “Cache files location” setting in the Master Settings panel of the Project Settings.

Once you’ve created optimized media, all you need to do to use it is to choose Playback > Use Optimized Media if Available to toggle optimized media on and off.

For more information on choosing which format to optimize to, creating and managing optimized media, and how optimized media interacts with raw media, see Chapter 7, “Improving Performance, Proxies, and the Render Cache.”
Relinking Media

DaVinci Resolve attempts to automatically keep track of the relationship between clips in your project and their corresponding source media on disk. If, for whatever reason, source media that links to clips in your project becomes unavailable because it’s been moved, DaVinci Resolve has several different methods of relinking those clips in the Media Pool. This section summarizes two methods of relinking, “Relink Media” and the “Relink selected clips” command. For more information on other methods of conforming projects and relinking media, see Chapter 57, “Conforming and Relinking Clips.”

Relink Media

If DaVinci Resolve fails to find your media, a Relink Media icon in the Cut page’s and Edit page’s Media Pools will highlight orange.

Clicking this icon opens a dialog box showing the volumes that the missing files initially belonged to. You can then use this information to track down the media on your file system, find that specific hard drive, or ask a client if they provided you the media from this volume. Clicking the Locate button lets you re-connect the missing clips to a new file location of your choosing. If the quick search initiated by the Locate buttons doesn’t find media that you know is there, you can initialize an exhaustive deep disk search for the media by clicking on the Disk Search button.

Relink Selected Clips

The appropriately named “Relink selected clips” command is the most flexible method of relinking clips in your project with clips in a directory of your choice, using file name and timecode as the primary criteria for reconnecting the relationship between each clip and its corresponding media file on disk.
To relink selected clips or clips in a selected bin:

1. Do one of the following:
   - Select one or more clips in the Media Pool browser that you want to relink, then right-click one of the selected clips or the selected bin, and choose “Relink Selected Clips” from the contextual menu.
   - Select a bin in the Media Pool bin drop-down menu that contains clips you want to relink, then right-click the selected bin and choose “Relink Clips for Selected Bin” from the contextual menu.

2. When the Relink File dialog opens, choose a volume and directory in which to look for the files you want to relink to, and click OK. DaVinci Resolve attempts to find every clip with a matching file name in the subdirectories of the directory you chose, using the original file paths of the clips being relinked to do this as quickly as possible. By first looking for the clips in the directories they were originally in, relinking can be quite fast.

3. If there are any clips that couldn’t be found using the method in step 2, you’re prompted with the option to do a “deep search” by a second dialog. If you click Yes, then DaVinci Resolve will look for each clip inside every subdirectory of the directory you selected in step 2. This may take significantly longer, but it should be completely successful so long as the media that’s required is within the selected directory structure.

4. If there are still other clips that couldn’t be found, you’re prompted to either choose another directory altogether to continue searching, or quit.
Chapter 27

Fast Editing in the Cut Page

The editing methods in the Cut page have been streamlined for fast editing, and the interface of this page and the methods of assembling clips together using different types of edits are designed to be easy to learn and quick to use.

Contents

Creating and Modifying Timelines 441
Creating New Timelines 441
Opening Timelines 442
About Tracks in the Cut Page Timeline 442
Adding Tracks 442
Deleting Tracks 442
Navigating Clips in the Viewer and Timeline 443
Viewer Options 443
Full Screen Viewer 444
Playing Clips and Navigating the Timeline in the Viewer 444
Scrolling Through the Timeline 445
Smart Reframe (Studio Only) 446
The Boring Detector 447
Setting In and Out Points 448
Setting In and Out Points Using the Keyboard 448
Setting In and Out Points Using the Pointer 449
Editing the Duration Field in the Cut Page Viewer 449
Change Clip Duration Dialog 449
Video Only and Audio Only Edits 450
Drag and Drop Editing 451
Append 451
Creating and Modifying Timelines

After you’ve imported and organized the media you need to use in a program, the next thing you must do is create a timeline. Timelines are the organizational entities that contain the edited sequences of clips that make up your program. You can have as many timelines as you like in your project, with each timeline being an independent arrangement of clips. Timelines are stored in the Media Pool and can be organized using bins, just like clips.

Creating New Timelines

A timeline is automatically created when you edit your first clip into the Timeline. You’ll see an icon for the new timeline in the Media Pool, where you can rename it.

You can also create a new timeline by either choosing File > New Timeline (Command-N), or right-clicking in the background of the Media Pool and choosing Create New Timeline. A dialog appears that lets you choose a start timecode (the default is 01:00:00:00), a name, how many video and audio tracks you want it to have, what kind of audio (the default is stereo), and whether or not you want to create an empty timeline, or a timeline that automatically includes all clips in the Media Pool with or without selected In/Out points (a quick and easy way of creating a stringout of all clips you’ve imported).

By default, all timelines share the same frame rate, resolution, and monitoring settings as the overall project. If you like, you can also click the Use Custom Settings button to choose individual frame rate, resolution, and monitoring settings for that timeline.

Once you’ve created a new timeline, double-clicking it will open it into the Timeline Editor.
Opening Timelines

If you only have one timeline in your project, that timeline is always seen in the Timeline Editor. If you have multiple timelines, you can double-click any timeline in the Media Pool to open it into the Timeline Editor, ready for editing. You can also switch from working on one timeline to another by using the drop-down list at the top of the Cut page Viewer. This unifies Viewer Timeline Selection behavior across the Cut, Edit, Color, and Deliver pages.

![Timeline Selection drop-down at the top of the Cut page Viewer](image)

About Tracks in the Cut Page Timeline

Tracks in the Cut page timeline combine a clip’s audio and video into a single track for convenience, as this makes it easy to keep audio and video organized and in sync when superimposing many clips together. This means that tracks have both video and audio enable controls in the track header controls, so that you can selectively disable video and mute audio when necessary.

![The Lock, Audio Enable, and Video Enable buttons to the left of the track number, in the header of a timeline track](image)

Each track also has a lock control, which lets you prevent clips on that track from being altered in any way.

Adding Tracks

If your timeline doesn’t have enough tracks, you can either click the Add Track button in the track header or right-click anywhere in the Timeline and choose “Add Track” and a new track will be added on top of the previously existing tracks.

**TIP:** Dragging a new clip to the undefined gray area at the top of the Timeline also adds a new track.

Deleting Tracks

If you want to delete a specific track along with all clips on that track, you can right-click anywhere in that track’s header and choose “Delete Track.”

If your timeline has too many empty tracks, you can right-click anywhere in the track header and choose “Delete Empty Tracks” and all empty tracks will be removed.
Navigating Clips in the Viewer and Timeline

Before you can start editing, you need to find which parts of which clips you want to use, and define where in the currently open timeline you want to make an edit. The Single Viewer in the Cut page has three options that let you choose what media you want to play through using the transport controls found at the bottom.

**Viewer Options**

Three options, selectable via buttons at the upper left of the Viewer, let you control what the Viewer shows.

- **Source Clip**: This option shows the currently selected clip in the Media Pool. This is the mode the Viewer automatically switches to whenever you double-click a clip in the Media Pool. In Source Clip, a scroll area appears at the bottom of the Viewer, the width of which represents the duration of the currently open clip. A playhead within the scroll area lets you scrub through the clip as a zoomed-in waveform and shows whatever audio is playing within the clip. Handles to the left and right of the scroll area let you reposition In and Out points within the clip to choose a section you want to edit into the Timeline. These In and Out points can also be set using the I and O keys. Once set, you can drag In and Out points to change them.

- **Source Tape**: Using this option, every single clip in the currently open bin, and any subfolders in that bin, of the Media Pool is shown in the Viewer as a “stringout” in the scroll area at the bottom of the Viewer. In the scroll area, each clip appears one after the other in a long strip, with the order determined by the Sort order. This makes it easy to scrub through a whole collection of clips while you’re figuring out what you want to use. As you play through, whichever clip the playhead intersects is selected in the Media Pool, so you know which clip you’re looking at.

- **Timeline**: This option shows the current frame at the position of the playhead in the Timeline. Whenever you click, drag, or adjust a clip in the timeline area, the Viewer switches to the Timeline. In this option there is no scroll area; you must use the timeline area to scrub through your program. However, in the space where the scroll area would otherwise be, icons appear to indicate when the playhead is positioned at the first or last frame of a clip in the Timeline.
– **Safe Area:** This drop-down menu overlays many useful framing guides over the Viewer to let you see what part of the image will be included and what will part will be cropped out if you change the Timeline’s aspect ratio. The framing guides can be turned on and off by toggling the Safe Area Framing Guide icon in the Viewer, and the exact guides can be selected in the drop-down menu.

– **Social Media:** 1:1, 4:5, 9:16, 1.91:1, 16:9.

– **Broadcast and Film:** 1.33, 1.66, 1.77, 1.85, 2.35.

– **Safe Area Guides:** These options add additional guide lines on the Viewer to protect your composition from possibly being cut off at the extreme edges of a physical cathode ray tube. While somewhat anachronistic in this age of flat screen digital televisions, many legacy programs still adhere to these guidelines. Safe Areas still can be useful guides in ensuring your image is not inadvertently cropped by the variety of mobile devices and social media sites in use today.

– **Action:** Keep all movement and important action within this box.

– **Title:** Keep all on screen text within this box.

– **Center:** Designates the exact middle of the image.

**Full Screen Viewer**

The Cut page has a Full Screen Viewer icon in the upper-right that can be clicked to enable Full Screen view. Press Escape to return to your normal view mode.

**Playing Clips and Navigating the Timeline in the Viewer**

Eight controls sit at the bottom of the Viewer. These let you play through and otherwise navigate clips and the Timeline in different ways. These controls are described from left to right.
– **Fast Review button**: Intended to help you watch through a large collection of media quickly, clicking this button begins accelerated playback through the Source Tape or through the Timeline, where the speed of playback is relative to the length of each clip you're playing through. Long clips play faster, whereas shorter clips play closer to real time. In this way, you can watch a lot of material really quickly.

– **Tools button**: The Tools button reveals a variety of controls for transform, crop, audio, speed effects, camera stabilization and lens correction, dynamic zoom, and compositing, covered in more detail later in this chapter.

– **Jog control**: Clicking and dragging within the jog control lets you scrub very precisely through the content of the Viewer.

– **Transport controls**: A set of buttons provide clickable controls to control playback of source clips and the Timeline, whichever the Viewer is set to display, each button has a matching keyboard shortcut. These include Previous Edit (Up Arrow), Stop (Spacebar), Play (Spacebar), Next Edit (Down Arrow), and Loop Playback (Command /).

– **Mark In/Out**: Clickable controls to set In and Out points respectively.

– **Playhead timecode**: A number field shows you the timecode value at the playhead of a clip or of the Timeline, to give you a numeric reference for where you are. There is also a dedicated timecode entry mode for the Cut page. There are three ways of telling DaVinci Resolve that you want to perform a timecode action, regardless of what the numeric keypad keys are assigned to in the Keyboard Customization preferences.
  – Select Playback > Goto > Timecode (=) and enter your timecode value.
  – Press “+” or “-” keys, and enter your timecode value to move the current position forward or backward by that amount.
  – Click on the Timeline Timecode display on the Viewer, and enter your timecode value.

### Scrolling Through the Timeline

The playhead in the Cut page is fixed. When you play, shuttle, or jog through your program, the clips in the Timeline flow past the playhead from right to left if you're playing forward, or from left to right if you're playing backward. This means that for playback, editing, or trimming, you bring the frame you want to see to the playhead, rather than bringing the playhead to the frame (as you do on the Edit page).

**To scroll or scrub through the Timeline, do one of the following:**

– Set the Viewer to show the Timeline, then use any transport or playback controls or keyboard shortcuts to move the clips in the Timeline back and forth, with the playhead indicating the current frame.

– Position the pointer within the Timeline Ruler of the Upper Timeline, and drag to the left or right to scrub through your entire program.

– Position the pointer within the Timeline Ruler of the larger Timeline Editor below, and drag to the left or right to scrub through the immediate vicinity of the current frame.

– You can use the navigation tools Playback > Previous / Next > Clip (Up Arrow/Down Arrow) or Marker (Shift - Up Arrow/Shift - Down Arrow) to navigate the Cut page Timelines.

**TIP:** If at any time you need to analyze the video in the Viewer, DaVinci Resolve’s full set of scopes is available in the Cut page by selecting Workspace > Video Scopes > On (Shift-Command-W).
Smart Reframe (Studio Only)

The Smart Reframe feature in DaVinci Resolve makes it easier to quickly reframe material across extreme aspect ratio changes. It’s useful for situations where you’ve shot a 16:9 horizontal video and find yourself needing to create a vertically-oriented 9:16 version for mobile phones and social media deliverables, or using 4:3 archival footage in a 2.39:1 widescreen movie. Smart Reframe can be used manually, or automatically executed using the DaVinci Resolve Neural Engine.

![Smart Reframe in action, with the Reference Point bounding box active (right)](image)

The Smart Reframe tool is found in the Sizing tab of the Inspector and is available in both the Cut and Edit pages.

To use the Smart Reframe tool:

1. Duplicate your Timeline, right-click the Timeline and choose Timelines > Timeline Settings, and click Use Custom Settings to change the Timeline Resolution to the aspect ratio needed for delivery. Make sure that “Mismatched resolution files” is set to “Scale full frame with crop,” and click OK.

2. Select one or more clips you want to reframe, and open the Inspector to the Sizing tab.

3. Open the Smart Reframe controls, leave the Object of Interest drop-down menu set to Auto (if you’ve selected more than one clip, Auto is the only setting available), and click “Reframe.” DaVinci Resolve will analyze your footage and should automatically adjust each individual clip’s position to a more aesthetically pleasing framing.

4. (Optional) If the “Auto” setting does not give you desirable results for a particular clip, you can manually select the main subject using the following steps.
   a. To manually select the subject area, choose “Reference Point” from the Object of Interest drop-down menu, and click the target icon just to the right of the menu. This automatically sets the Viewer mode to Smart Reframe, exposing the onscreen controls for choosing a reference.
   b. Drag the Reference Point bounding box around the main subject of interest in the frame. You may use the Transform controls directly above in the Inspector to move the source clip around if your subject is outside the current framing.
   c. Click “Reframe.”

![The Inspector’s Smart Reframe controls showing the manual reference point selected](image)

DaVinci Resolve locks onto and, if necessary, tracks your subject using the reference you’ve selected, automatically panning and scanning the original clip as needed to keep the reference within the new aspect ratio. While involving a bit of manual adjustment, this function still dramatically reduces the time involved in pan and scanning footage by manually adjusting and keyframing the sizing controls.
The Boring Detector

The Boring Detector performs a live analysis of the lengths of each of your clips on the Timeline and then highlights areas that are too long or too short and may demand your attention. It’s accessed by clicking the Boring Detector Icon on the far left of the Cut page Edit commands and can be toggled off by clicking the icon again.

Analyze Timeline Edits

The Boring Detector’s parameters are modifiable in its Analyze Timeline Edits window.

– **Boring Clips**: By adjusting this slider, you can set the minimum number of seconds that a clip’s duration has to be before being flagged as too long. Clips that exceed this length are highlighted in light gray on the Upper Timeline.

– **Jump Cuts**: Adjusting this slider sets the maximum number of frames that a clip’s duration has to be before being flagged as too short. Clips that are shorter than this length are highlighted in red on the Upper Timeline. Setting this to 2 frames can help you automatically find accidental “flash frames.”

– **Cancel**: Closes the window without making any changes to the Boring Detector’s analysis.

– **Analyze**: Starts the live analysis of your timeline using the criteria you’ve selected above. The Boring Detector is persistent and continues to function as you make further edits in the Cut page. It can be turned off by clicking the Boring Detector icon again.
Setting In and Out Points

Ordinarily, source media is much longer than the actual clips you’ll be using in a program, so it’s important to be able to define a range of media you want to edit into the Timeline. This is done by setting In and Out points, either in the Media Pool in Thumbnail or Filmstrip mode, or in the Viewer in Source Clip or the Source Tape.

Setting In and Out Points Using the Keyboard

When scrubbing through a thumbnail or filmstrip in the Media Pool, you can press the I (In) or O (Out) keys to define a range of media. The edit points appear superimposed over the thumbnail area of the clip, as well as the scroll area of the Viewer if the clip is being mirrored there.

When scrubbing or shuttling through media in the Viewer in Source Clip or the Source Tape, or through your program with the Viewer in Timeline mode, you can press the I (In) or O (Out) keys to define a range of media.

When scrubbing or shuttling through the Timeline as you drag the ruler to the left and right, you can press the I (In) or O (Out) keys to define a range for incoming edit operations. The range is marked in both the upper and lower areas of the Timeline.
Setting In and Out Points Using the Pointer

If you’re using a pointing device such as a mouse, trackpad or tablet, you can drag the In and Out handles found underneath the scroll area at the bottom of the Viewer to define a range of media.

Once you’ve set In and Out points, the jog In and Out controls, located at the far left and right of the scroll area in the Viewer, let you fine-tune the location of the In and Out points. Click and drag on the Jog In or Jog Out controls to move either edit point in precise increments. While you drag, a filmstrip above shows you how many frames you’re trimming.

In and Out points set in the Timeline Ruler (either of the Upper Timeline or the Timeline Editor) can be dragged to the left or right to fine-tune them.

Editing the Duration Field in the Cut Page Viewer

When editing in the Cut page, you set In and Out points to insert a specified range of video. The duration of that video range appears in the Duration field, which is in the upper-right corner of the Viewer.

This field is now editable, and updates the Out point to match the value you enter. You can directly enter a certain number of frames, use the + or - modifiers to change the value by that exact amount, or make adjustments to the hh:mm:ss:ff field directly.

Change Clip Duration Dialog

The Change Clip Duration dialog in DaVinci Resolve 17 allows you to directly change the duration of a clip by typing in frames, a timecode value, or using time and frame-based presets. You can activate the Change Clip Duration dialog by selecting one or more clips on the Timeline and choosing Clip > Change Clip Duration (Command-D), or by right-clicking on a clip and choosing Change Clip Duration from the contextual menu. The Change Clip Duration dialog works both on the Cut and Edit pages.
Options for the Change Clip Duration Dialog box:

- **Format:** You can choose between working with Time (Timecode) or Frame values.
- **Duration:** Type in the timecode value or number of frames you wish to make the new duration of the selected clip.
- **Preset:** Select a duration by clicking on 1, 5, or 15 seconds (or their equivalent value in frames). End will extend the duration to the last frame of the selected clip, regardless of any Out points set.
- **Extend Beyond Clip Length (Cut page only):** This will append black filler to any clip whose duration is set longer than the clip itself.
- **Cancel/Change:** Click Cancel to exit without changing the duration of the clip, or Change to apply the duration change to the selected clip.

**TIP:** You can change the duration for more than one clip at a time by selecting multiple clips before opening Change Clip Duration. All clips selected will be changed to the same duration set in the Change Clip Duration dialog box.

**Video Only and Audio Only Edits**

Normally, any edit function in the Cut page uses both the Audio and Video sections of a clip to insert into the Timeline. However, there are several scenarios where you would only want either the Audio or the Video portions to be used instead.

**To perform an Audio Only edit:**

- Select the Audio Only icon to the left of the Upper Timeline, deselect to return to the normal audio and video edit.

**To perform a Video Only edit:**

- Select the Video Only icon to the left of the Upper Timeline, deselect to return to the normal audio and video edit.
Drag and Drop Editing

Drag and drop editing can be an easy way of assembling clips into a loose edit. Once you’ve defined a range of media using the Source Clip or the Source Tape, you can click and drag either from the Viewer or the Media Pool to the Upper Timeline or the Timeline below to edit a clip into your program. How and where you drag determines how that clip will be edited.

Append

If you drag a clip onto an empty timeline, or to the dark gray area to the left of clips in the Timeline, that clip will become the first clip of your edit. If you drag a clip to the far left or right edge of all other clips in the upper or lower areas of the Timeline, you will append that clip to the ending or beginning of the Timeline.

Ripple Overwrite

If you drag a clip onto a pre-existing clip in either the Timeline or Upper Timeline so that the entire clip highlights and you drop it immediately, you’ll perform a Ripple Overwrite edit, substituting the previous clip in the Timeline with the new clip. If you’ve ripple overwritten a clip on Track 1, all clips to the right of it will be rippled to make room if the incoming clip is longer, or close the gap if the incoming clip is shorter.
**Overwrite**

If you drag a clip onto a pre-existing clip in either the Timeline or Upper Timeline and wait a moment, the Timeline overlay changes from a highlight over the whole clip to a highlight showing just the portion of the incoming clip overlaid on the existing clip. When you drop the clip, you’ll perform an Overwrite edit, which writes over the media that’s already in the Timeline with the media of the incoming clip. Overwrite edits don’t ripple the Timeline.

(Top) Dragging clip DD onto clip BB on the Timeline and pausing to perform an Overwrite. (Bottom) Clip DD overwrites the middle of clip BB, breaking it into two pieces while the Timeline remains the same duration.

**Using Cut Page Edit Commands**

At the bottom of the Media Pool is a set of five buttons that let you make other kinds of edits. Some of these edits have keyboard shortcuts assigned to them and are also available via dedicated keys on the DaVinci Resolve Editor Keyboard.

The edit buttons underneath the Media Pool, (Left to Right) Smart Insert, Append, Ripple Overwrite, Close Up, Place On Top, Source Overwrite

**Smart Indicators**

Some of the intelligent tools in the Cut page do not require you to select specific In and Out points in the Timeline. They rely on the playhead’s relative position over a clip to guess where you likely will want to make your edit. The point where DaVinci Resolve intends to make that edit is marked using a Smart Indicator icon on the Timeline Ruler.

Smart Indicator showing where an edit will occur
Setting Up and Performing Edits

No matter what kind of edit you intend to make, the process of setting them up and performing them is the same. This section describes the general process of setting up an edit, and the following sections will describe how each particular edit works.

To set up and perform an edit:

1. First, locate a clip you want to edit into the Timeline. There are two general ways of doing this:
   a. Open a bin with clips you want to use, then click the Source Tape in the Viewer to show a stringout of all clips in the current bin, and its subfolders, in the currently selected sort order. Now, you can scrub around all these clips using JKL or the DaVinci Speed Editor’s shuttle/jog-scroll wheel to find the media you’re looking for.
   b. Open a bin with clips you want to use, and navigate the thumbnails, filmstrips, or columns to select the clip you want, using the Search field if necessary to help find the clip you’re looking for.

2. Scrub a thumbnail or filmstrip, or use the controls in the Viewer, or use the controls of your DaVinci Speed Editor to locate frames at which you want to set In and Out points to define an edit range, and use the I (In) and O (Out) keys to set those points.

3. If necessary, choose which video track you want to edit to by clicking in its track header to select it. Selected tracks are highlighted.

4. Perform an edit to put the selected range of the source clip into the selected video track at the desired frame, using either the buttons at the bottom of the Media Pool, or keyboard shortcuts. Different edit commands will put the source clip into different locations.

5. After you’ve committed your edit, you can press Q (or click the Timeline Viewer button) to switch the Viewer to the Timeline to play and review the edit you’ve just made, and then press Q again to switch back to the Source Clip or Source Tape (whichever was last used) to locate the next clip you want to edit, starting all over again at Step 1.

Smart Insert

Automatically inserts an incoming clip at the closest edit point to the playhead (as shown by the Smart Indicator) on the selected track, pushing all clips to the right of the edit point forward to make room for the incoming clip if you’ve inserted to Track 1. Because this is a smart operation, you are prevented from inserting a clip at any arbitrary frame; incoming clips are only inserted at the closest previously existing edit point.

(Top) Before doing a Smart Insert, (Bottom) After inserting clip DD between clips AA and BB

Append

The position of the playhead is ignored; incoming clips are always placed after the last clip in the Timeline.
Ripple Overwrite

At its simplest, Ripple Overwrite substitutes a clip in the Timeline with an incoming clip. If you use Ripple Overwrite on a clip on Track 1, this will automatically move all clips that are to the right of the affected clip in the Timeline either forward to make room if the incoming clip is longer, or back to eliminate gaps if the incoming clip is shorter.

However, Ripple Overwrite works differently if you’ve set In and Out points in the Timeline to define a range. In this case, the incoming clip substitutes whatever portion of the Timeline falls within this range, moving all other clips that are to the right of the affected range either forward to make room if the incoming clip is longer, or back to eliminate gaps if the incoming clip is shorter.
Close Up

Lets you edit a clip into the Timeline as a zoomed-in close up, to make up for a lack of actual close ups that would have been shot with either longer lenses or by moving the camera closer to the subject. This function is particularly useful when you’re working with 4K media in a 1080 timeline, or 8K media in a 4K timeline, which enables you zoom into existing wide shots to create medium shots, or medium shots to create close up shots, with no loss of quality.

Performing this edit adds the incoming clip as an approximate 150% scaled close up, also performs a face detection, and if a face or faces are found, automatically re-positions the face in the frame. Which frame of the Timeline the incoming clip aligns with depends on the following:

- If no In or Out points are set on the Timeline, the incoming clip aligns with the Timeline playhead as the In point.
- The incoming clip aligns with a timeline In point if one has been set.
- The incoming clip’s Out point will align with a timeline Out point if one has been set without an In point. This “backtimes” the clip.

Place On Top

Lets you edit the incoming clip as a superimposition above whatever other clips are in the Timeline; the incoming clip is always placed on top, so if there are clips in tracks 1, 2, and 3, the incoming clip is automatically placed on track 4, regardless of which track is selected. The frame the incoming clip aligns with depends on the following:

- The incoming clip aligns with the closest timeline edit point in proximity to the playhead (as shown by the Smart Indicator) if no timeline In or Out points have been defined. The playhead is ignored.
- The incoming clip aligns with a timeline In point if one has been set.
- The incoming clip’s Out point will align with a timeline Out point if one has been set without an In point. This “backtimes” the clip.
Source Overwrite

This edit requires overlapping timecode in multiple clips to work properly, such as when recording synced timecode to multiple cameras during a multi-cam shoot. If there is no overlapping timecode, this edit does nothing.

If you are working with footage from multiple cameras that have synced timecode, then the easiest way to use this edit type is to set In and Out points over a clip in the Timeline where you want to cut away to another angle. In the following example, a wide shot of a cooking show covers the moment when the chef starts slicing a chili.

Setting Timeline In and Out points to identify a cutaway

You can then select a clip in the Media Pool that corresponds to the desired angle you want to add as a cutaway, that has synced timecode that overlaps with the clip in the Timeline. Don’t set In and Out points; if necessary you can clear previously set In and Out points by pressing Option-X.

Choosing a Media Pool clip from another camera that has overlapping timecode

When you click the Source Overwrite button, a synced section of the selected Media Pool clip will be edited into the Timeline between the In and Out points you placed, superimposed on top. The result is a perfectly timed cutaway.
Using Source Overwrite to edit a superimposed and synced section of the source clip into the Timeline between the In/Out points

Alternatively, you can also use Source Overwrite to automatically place a source clip with a marked In/Out region on top of a clip in the Timeline so that its timecode syncs with the timecode of the timeline clip, when you don’t know exactly how much of the incoming source clip you want to edit into the Timeline, and you just want it synced appropriately.

**Overwrite**

While there’s no button available for performing an overwrite edit, you can use the F10 key to perform an overwrite edit, which overwrites a section of the Timeline with the incoming clip, without moving other clips in any way. The frame the incoming clip aligns with depends on the following:

- The incoming clip aligns with the playhead if no timeline In or Out points have been defined.
- The incoming clip aligns with a timeline In point if one has been set.
- The incoming clip’s Out point will align with a timeline Out point if one has been set without an In point. This “backtimes” the clip.

**Source Tape Editing**

While all the features of the Cut page can be used individually, certain features are designed to be used in conjunction with each other to make your editing experience more streamlined. For example, combining the File Inspector, Source Tape, Metadata View, and the Navigable Folder Structure can create a well structured and organized project out of a single folder of unorganized clips.

**Metadata Entry Using the File Inspector**

The first step in organizing any project is metadata entry. In our initial project we have a large amount of clips all residing in a single Master Bin. We need to add appropriate metadata to these clips, and to do this we will be using the File Inspector.
An unorganized Media Pool in the Cut page

After the File Inspector is open, check the box Auto Select Next Unsorted Clip, and this will automatically select the same metadata field in the next clip in the Media Pool, after you hit the return key. Enter in the Scene, Shot, and Take metadata for each clip, based on the information on the slate in each clip.

Once each clip has its scene, shot, and take metadata, select all the clips in the Media Pool, then enter the text string “%{Scene}-%{Shot}-%{Take}” in the Name field of the File Inspector. These variables will replace the clip names for all clips with their scene shot and take numbers separated by underscores, for example: “02A_CU_03”.

Entering Scene, Shot, and Take metadata in the File Inspector, and renaming all clips via variables

Now make two new bins in the Media Pool, Scene01 and Scene02, and drag all the clips that start with the name 01 into the Scene01 folder, and all the clips that start with the name 02 into the Scene02 folder. Our metadata entry for this project is now done.
Using the Source Tape

Now turn on the Source Tape, by clicking on its icon in the Viewer. Select Metadata View from the Media Pool view options, and then Sort By Scene, Shot in the Sort menu. You will now see the clips clustered by scene in the Media Pool, and all clips from both scenes are laid out in scene order in the Source Tape viewer. Selecting a specific clip in the Media Pool will snap the playhead to the first frame of that clip in the Source Tape. From here you can easily see the progression of the shots (take two follows take one, etc.), and continue your editing from here without having to hunt and click in the Media Pool.

Limiting the Source Tape Scope by Folder Structure

As your project grows, it can become unwieldy to constantly have an entire film’s worth of media in the Source Tape. It is possible to limit the scope of the Source Tape at the bin level. As you navigate in the Source Tape, the current clip is highlighted, and its hierarchy will now appear in top of the Media Pool title bar. By clicking directly on bins in this bin path, you can quickly broaden or narrow the scope of the Source Tape. If you click on Scene02, the Source Tape will then zoom in to only show you clips in that folder. Clicking back on Master will zoom out the Source Tape to show the clips in all folders again.
The Source Tape limited to showing only clips from Scene02

The Source Tape limited to showing only clips from Scene01

The Source Tape broadened to showing all clips in the Master folder

This is also useful when navigating bin structures that reflect the original camera file system. For example, you may have a camera that records each memory card as a separate folder, and then each individual clip is saved as a separate folder inside that folder. When you bring this file system into the Media Pool using the Create Bins option, these nested levels are mirrored in the Media Pool bin structure. Now when you click on a card bin in the Source tape, it will directly show you all the clips on that card, rather than show many individual sub-bins. This view is also viewable in Thumbnail, List, and Filmstrip views.
Sync Bin Multicam Editing

DaVinci Resolve has a number of tools to make editing multi-camera productions more intuitive and efficient. If simultaneously recorded clips from different cameras share common timecode, DaVinci Resolve can automatically sync all of these different camera angles together as you edit. The tools described in this section act as a sort of digital assistant editor that is constantly searching through all your media, and presenting all of the relevant shots to you at the exactly the right time. This functionality, combined with the DaVinci Resolve Speed Editor, makes the Cut page an extremely powerful multi-camera editor.

Preparing Footage for Sync Bin Editing

In order to properly work with the Sync Bin, every clip in that bin must have the following characteristics.

All Clips Must Have a Common Timecode

Professional video cameras and audio recorders generally have the ability to “jam-sync” their timecodes together so that each separate video and audio source records the exact same timecode at the exact same time. Jam-syncing timecode is the quickest, easiest, and most reliable method to ensure your footage syncs perfectly.

If your footage does not have a common timecode, you will need to go through some extra steps to ensure that all your material matches up at the correct time. For more information, see the Sync Clips Window section below.

All Clips Must Have a Unique Camera Name

Most professional video cameras will have some sort of mechanism for naming the camera in its internal menu system. This camera name is then recorded as metadata in each captured clip, which can be read automatically by DaVinci Resolve. Cameras should be named either alphabetically (A, B, C, etc.), or numerically (1, 2, 3, etc.), and in a sequential order totaling the number of cameras that you are recording with.

If your camera does not automatically record this information (or it’s set incorrectly), you can manually set the camera’s name by modifying the Camera # field in the Metadata Editor in the Media Pool.

Sync Clips Window

If your footage does not share common timecode, or if the existing timecode needs to be modified for any reason, the Media Pool in the Cut page offers a Sync Clips window that allows you to modify the sync of all clips in a bin. It is accessed by clicking on the Sync Clips Window icon on top of the Media Pool.

The Sync Clips window opens and shows a live multi-camera sync Viewer on the left, and a standard clip Viewer on the right. There is also a timeline below that shows the temporal relationship of all the clips in the bin.
DaVinci Resolve offers several tools to automatically align your shots into perfect sync.

- **Timecode**: This button will try to align all the clips in the Sync Clips window by timecode; this is the default option.

- **Audio**: This button will try to align all the clips in the Sync Clips window by analyzing the audio tracks of each clip. In order for this to work, each clip must have at least a portion of the same audio track recorded clearly enough to analyze. An error message will notify you of which tracks could not be synced by this method.

- **In Point**: This button will try to align all the clips in the Sync Clips window by their user set In point. This is useful if you have a common mark that was shot across all cameras, for example a slate that claps closed, or a camera flash.

- **Out Point**: This button will try to align all the clips in the Sync Clips window by their user set Out point. This is useful if there was a common tail slate.

- **Sync**: This button will execute the Sync By method selected above.

Once all of the clips in the window are synced appropriately, hit the Save Sync button in the lower right-hand side of the window.

**Manually Syncing Clips in the Sync Clips Window**

If none of the Sync By tools is appropriate for the clips in your bin, you can manually sync the clips together by dragging each clip to the appropriate position on the Sync Clips Window timeline. For finer control, select the clip you want to sync and press the Comma (,) or Period (.) keys to nudge the clip backward or forward by one frame. Shift-Comma (,) or Shift-Period (.) nudges the clip by 5 frames (default), or by the amount of frames set in the “Default fast nudge length” setting in the General
Settings section of the Editing panel in the User settings of the Resolve Preferences. Each clip has its own track, and you can enable sync lock in the right-hand Viewer to prevent accidental slipping.

Once all of the clips in the window are synced appropriately, click the Save Sync button in the lower right-hand corner of the window.

Using Your Newly Synced Clips

After saving the sync on your clips, a new Multicam clip will appear in the Media Pool. If you select the Thumbnail View, a Sync icon appears on all the clips you modified. If you want to modify your sync, right-click on a thumbnail and select Open Sync Group to reopen your clips in the Sync Clips window. Once you place your first clip on the Timeline as a reference, you are now ready to use the Sync Bin to edit.

Sync Bin Editing

The core idea behind the Sync Bin layout is that instead of traditionally scrubbing through your timeline and clips independently, you now only have to scrub through your timeline. In the Media Pool, all of the clips that exist with that same timecode value will automatically scrub in sync with the playhead. This allows you to always have the exact clips that will fit perfectly in your timeline available at your fingertips.

Selecting this mode automatically changes the layout of the Media Pool and the Viewer to better accommodate multi camera editing in the Cut page.

Edit in Your First Clip from the Media Pool

Choose a clip that will be your base layer and place it on Track 1. This clip is used as the reference for all of the other clips in the Sync Bin. Then press the Sync Bin icon.

Media Pool in the Sync Bin

All of the clips in the bin, and its subfolders, are presented in filmstrip mode. The clips are ganged together automatically by timecode and sorted by camera number. An additional playhead appears at the current timeline position, and moving any of the three playheads in the Cut page will scrub through all of the clips in the Sync Bin at the same time.

Viewer in the Sync Bin

The Viewer switches to a live Multi Viewer for up to nine cameras. Each camera is labeled, numbered, and the active camera in the Timeline is highlighted in red. Cameras that were not active at the current playhead time are blacked out.
The Sync Bin camera selection can be viewed full screen in the Cinema Viewer by pressing “P” on your keyboard, allowing you to see a larger, more detailed view of each specific camera. In this full-screen mode, the Sync Bin view controls operate identically to those in the normal Viewer.

The Media Pool and Viewer in Sync Bin view

Select Your Timeline In Point
Select the In point on your timeline by scrubbing the timeline playhead to the position you wish your media to start. As you do this, all of the clips in the Sync Bin will scrub along with the playhead position. Finding and selecting your edit points in the Sync Bin is greatly simplified, as all of your possible synced media choices are available instantly.

When the “Video Only” mode is activated in the Cut page, audio from the sources in the Sync Bin are now muted, and the audio playback is from the clips in the Timeline only.

Select Your Camera
In the Multicam Viewer, select the camera angle you wish to use as your source material by doing one of the following:

– Clicking on the appropriate camera in the Multicam Viewer
– Clicking on the appropriate camera number icon in the Filmstrip Viewer
– Pressing the number key of the camera on the keyboard

The Viewer will then go into Single Clip mode, showing the camera you selected. To return to the Multi Viewer, click on the circled X close icon, or simply press the Escape key.

The clip will automatically set an In point at your current timeline position, with a default duration of five seconds. You can then manually set the Out point of the clip wherever you want.
Make the Source Overwrite Edit

Once your clip’s edit points are chosen, click on the Source Overwrite button and your selected camera clip will be perfectly positioned in sync on your timeline. The playhead will then automatically advance to the clip’s Out point, the Multi Viewer will return, and so be instantly ready for the next edit.

**TIP:** Because the actual media in the Sync Bin determines the overall limit of the clips, and not the Timeline, it is possible to scroll past the end of the Timeline to make an edit. When you are past the end of the Timeline, the playhead now represents the Out point instead, which allows the clip to backfill itself to fit the exact duration required to fill in the Timeline.
Chapter 28

Trimming in the Cut Page

Once you’ve assembled a sequence of clips together into a loosely edited timeline, the Cut page provides numerous methods for modifying them in the Timeline. These tools are intended to improve the pace of your program by fine-tuning the timing of each clip, as well as the edits that separate them. The idea is to make these kinds of adjustments easy, so your program’s content is clear, and the timing of your program’s playback is satisfying. This process of making modifications to the edits in a timeline is referred to as “trimming.”

Contents

Tools That Help You Work in the Timeline 467
Snapping 467
Locking, Muting and Disabling Tracks 468
Audio Trim View 469
Timeline Markers 469
Add Track 470
Making Selections 470
Moving Clips in the Timeline 472
Ripple Overwriting An Entire Clip in Track 1 472
Overwriting the Middle of Other Clips 472
Overwriting The Edges of Other Clips 473
Swapping Clips 473
Copy, Cut, and Paste 474
Splitting Clips 474
Disabling and Deleting Clips 475
Disabling and Muting Clips 475
Deleting Clips 475
Deleting Parts of Clips 476
Trimming Clips 476
Resize Clips While Rippling the Timeline 476
Rolling an Edit 477
Slipping Clip Content 478
Trimming Edits in the Viewer 478
Trimming Transitions in the Viewer 479
Tools That Help You Work in the Timeline

As you begin the process of trimming clips in the Timeline, a series of buttons at the top left of the Timeline help you to align clips and keep track of important frames while you work.

Locked or Free Playhead

A pair of buttons at the upper left-hand corner of the Timeline lets you choose whether you use a locked or free playhead.

When set to locked, the playhead is fixed in the center of the Timeline, and your edited clips scroll past it as you play (press the Spacebar), jog, or shuttle (use the JKL keys) in either direction. Locked mode works great when you use the DaVinci Resolve Editor Keyboard, because the Timeline flows past the playhead while you use the Jog/Shuttle/Scroll wheel. You can also scroll the Timeline using your pointer by dragging the Timeline Ruler at the top to the left or right, which also drags all of your clips to the left or right.

When set to free, the playhead moves across the clips as you play (press the Spacebar), jog, or shuttle (use the JKL keys) in either direction; the clips stay still. This mode can be useful when you’re doing precision trimming in the Timeline using a pointing device, as the clips stay put while you drag parts of clips to make adjustments. Once the playhead gets to the right or left edge of the Timeline, the Timeline pages over to reveal the next part of your edit. You can also move the playhead by clicking in the Timeline Ruler to jump the playhead to that frame, or by positioning the pointer over the playhead’s top handle, or over the playhead itself, and dragging the playhead wherever you want it to go.

Snapping

When dragging clips around the Timeline, you can click the magnet-shaped Snapping button in the toolbar, or press N, to enable or disable snapping.

When snapping is turned on, clip in and out points, markers, and the playhead all snap to line up with one another, making it easy edit clips together at their boundaries, or to line up clips with markers or the playhead as reference for key frames you want to cut to. When a clip’s boundary is snapping, a white line shows you the edges that are being aligned with one another.
The indicator that appears when clip boundaries are snapping to another edge

**NOTE:** When the playhead is locked, clips don’t snap to it.

However, it’s also important to be able to turn snapping off when this behavior impedes your ability to make small adjustments to clips in the Timeline. You can press N to temporarily turn snapping on or off while you’re in the middle of dragging a clip in the Timeline, or while scrubbing the playhead using the pointer.

- When you change snapping while dragging a clip, an edge, or the Timeline, it’s considered to be a temporary operation, and snapping reverts to its previous state when you release the mouse button.
- When you change snapping in between dragging operations, the snapping state remains set until the next time you change it.

### Locking, Muting and Disabling Tracks

As you work in the Timeline, you may find it useful to lock tracks with clips you don’t want to accidentally change as you work. For example, you might lock an audio track that has an edited piece of music you’re now cutting other video and audio clips to, so you don’t accidentally alter or trim the music that serves as the base of your program. Clips on locked tracks appear stippled to let you know they can’t be altered.

You may also find it useful to mute the audio or disable the video of tracks you don’t want to see while playing the Timeline. For example, you might want to disable a track filled with title graphics if you want to get a closer look at the underlying video in the background. Each track has Mute and Enable controls, while audio-only tracks only have Mute controls. White controls are enabled, while gray controls are disabled.
Audio Trim View

When performing a trim operation in the Cut page, you can set the option to expand the audio waveform of a Timeline clip while trimming. This mode gives a much more accurate view of the audio, making it easier to pick a specific edit point between words, beats, etc.

To toggle Audio Trim view:

– Click the Audio Trim icon, between the Snapping and Marker tools.

With this option enabled, you’ll see an expanded waveform for audio/video clips that are being trimmed in the Timeline, while you’re trimming. This shrinks back down after you finish the trim operation.

Timeline Markers

You can place markers in the Timeline Ruler (of both the Upper Timeline and the Timeline Editor) to keep track of important frames of clips you want to remember, alternate edit points you’re thinking of, key moments in the edit, or to make notes of things you need to do. You can edit marker text, which appears as an overlay in the Viewer, and you can change the color of markers to distinguish them from one another.

The Marker button in the Timeline track header
Methods of working with markers:

- **To add a marker:** Move the playhead to a frame you want to mark, then click the Marker button in the Timeline header, or press the M key.

- **To jump the playhead among markers:** Hold the shift key and press the Up or Down Arrow keys to jump the playhead from marker to marker.

- **To edit a marker’s name, text, color, or keywords:** Double-click a marker, or jump the playhead to a marker and press M again. When the marker dialog opens, edit the Name, Notes field, Keyword field, or color of the marker, then press Return or click Done to close the dialog. Markers with custom notes appear with a dot.

- **To move a marker:** Drag a marker to another frame in the Timeline Ruler.

- **To delete a marker:** Select a marker, and press Delete. Or, align the playhead with a marker, and press Option-M. Or, jump the playhead to a marker, press M to open the marker dialog, and then click Remove Marker.

Blue, red, and orange markers in the Timeline; the red marker contains text, the others do not

Add Track

The Add Track button on the right side if the Timeline track header will automatically add a new video track to the Timeline.

Making Selections

As you continue to work in the Cut page, it becomes increasingly helpful to know how to make different kinds of selections, both in the Media Pool and in the Timeline. Most of these methods of selection should be familiar to you if you have experience with other media applications or file managers.

Methods of selecting clips in the Media Pool:

- **To select a single clip:** Click a clip in the Media Pool. Once you’ve selected a clip, you can use the Up and Down arrow keys to move the selection to other clips.

- **To select a contiguous range of clips:** Drag a selection box over all the clips you want to select, or click to select the first clip in a series, then Shift-click the last clip to select those clips and everything in between.

- **To select a noncontiguous range of clips:** Command-click each clip you want to include in the selection. Or, you can hold the Command key down while you drag bounding boxes over unselected clips to add them to the current selection, or over selected clips to remove them from the selection.

- **To select all clips:** Select one clip, then choose Edit > Select All (Command-A).
Methods of selecting clips in the Timeline:

- **To select one clip:** Click a clip with the mouse. Command-clicking that clip de-selects it.
- **To de-select all clips in the Timeline:** Click in any empty area of the Timeline to de-select everything, or press Command-Shift-A.
- **To select a continuous range of clips by dragging:** Drag a bounding box from an empty area of the Timeline to surround a group of clips.
- **To select a continuous range of clips by Shift-clicking:** Click the first clip you want to select, and then Shift-click the last clip you want to select, and all clips in-between will automatically be selected as well.
- **To select a discontinuous range of clips:** Command-click any clips to select them no matter where they appear on the Timeline. Command-clicking a selected clip deselects it.
- **To select all clips in the Timeline from the playhead forward:** Right-click the top handle of the playhead, and click the right button on the radial menu that appears.
- **To select all clips in the Timeline from the playhead backward:** Right-click the top handle of the playhead, and click the left button on the radial menu that appears.

The radial menu that appears when you right-click the top handle of the playhead

Methods of selecting edits in the Timeline using the pointer:

- **To select an edit to roll:** Move the mouse to the center of an edit point, and when the ripple cursor appears, click to select the edit.
- **To select just the incoming or outgoing half of an edit point to resize:** Move the mouse to the left or right of the center of an edit, and when the resize/ripple cursor appears, click to select that portion of the edit.
- **To select multiple roll points:** Command-click the center of multiple edit points. Command-click a selected edit point to deselect it.
- **To select multiple resize points:** Command-click the left or right sides of multiple edit points.
- **To de-select all clips in the Timeline:** Click in any empty area of the timeline to de-select everything.

Keyboard shortcuts for selecting edits in the Timeline:

- **To select an edit point from the keyboard:** Press V to select the nearest edit point to the playhead.
- **To change an edit selection from the keyboard:** Once you’ve selected an edit point, press U to toggle among selecting the outgoing half, incoming half, or the entire edit.
- **To de-select all edits in the timeline:** Press Command-Shift-A.
Moving Clips in the Timeline

Once you’ve edited some clips into the Timeline, you’ll probably want to start fine-tuning the edit by moving clips around. Different operations can be performed depending on how you move these clips. All of these techniques work in both the Upper Timeline and the Timeline Editor.

Ripple Overwriting An Entire Clip in Track 1

Drag a clip in the Timeline or Upper Timeline over another clip in the Timeline so that the pointer overlaps that clip, and quickly drop it onto another clip in Track 1. The clip you dragged replaces the clip you dropped it onto, and all clips to the right are moved to either make room (if the dragged clip is longer) or to close the gap (if the dragged clip is shorter).

NOTE: If you wait too long, this Ripple Overwrite operation will turn into an overwrite operation. If you drag a clip in Track 1 onto a clip in any other track, you can only do an overwrite, not a ripple overwrite.

Overwriting the Middle of Other Clips

Drag a clip in the Timeline or Upper Timeline over another clip in the Timeline so that the pointer overlaps that clip, and pause until the clip you’ve selected is overlaid on top of the second clip, and release the mouse button. The target clip is overwritten by the duration of the clip you dragged and split in two.
Overwriting The Edges of Other Clips

Drag a clip in the Timeline or Upper Timeline over the edge of a neighboring clip without letting your pointer overlap it, then drop the clip. The overlapping part of the neighboring clip will be overwritten.

Swapping Clips

Drag one or more clips from one part of the Timeline or Upper Timeline to another so that the pointer overlaps an edit between two clips (the edit point turns purple), and drop the clip. The clip(s) you dragged are now moved so that they’re inserted at the edit point you targeted.
Copy, Cut, and Paste

Clips can be cut, copied, and pasted in the timeline or Upper Timeline to duplicate them or move them around, just like words in a word processor.

To cut/copy and paste in the Timeline:
1. Select one or more clips in the Timeline.
2. Do one of the following:
   a. Press Command-C to copy them (the selected clips remain where they are).
   b. Press Command-X to cut them (the selected clips are removed and the Timeline automatically ripples itself to close the gap).
   c. Move to another part of the Timeline, then press Command-V to paste the clips. The clips are pasted to the frame at the playhead, to the same track they were copied from, and overwrite whatever other clips are at that part of the Timeline.

Splitting Clips

You can split any clip into two pieces, effectively adding an edit point in the middle, in preparation for moving part of a clip, deleting part of a clip, inserting another clip at that edit point, or adding an effect of some kind to one part of a clip but not another.

To split a clip:
1. Move the playhead to the frame of a clip where you want to split it.
2. Do one of the following:
   – Right-click the clip and choose Split from the contextual menu.
   – Right-click the top handle of the playhead and click the Split button that appears on the radial menu.
   – Press Command-Backslash.
   – Press the Split Clips (scissors) icon on the far left of the Cut page Edit commands.
Disabling and Deleting Clips

Clips that you no longer want can be disabled or deleted.

Disabling and Muting Clips

You can turn off the audio and/or video for a clip in the Timeline, without removing the clip itself. This is useful in instances where you want to use a clip’s audio or video selectively, or for instances where you want to disable the audio and video for a clip that you don’t want to use, without eliminating it completely from the Timeline in case you change your mind.

Disabling Clips

You can turn off a clip’s video while leaving it in the Timeline by selecting it and pressing D, or by right-clicking it and deselecting Enable from the contextual menu. The clip turns dull to show it’s disabled. Audio will continue to play for that clip unless you mute it as well.

A disabled clip in the Timeline

Muting Clips

You can turn off a clip’s audio while leaving it in the Timeline by right-clicking it and choosing Mute from the contextual menu. A mute icon is superimposed over the beginning of the clip to show audio is disabled. Video will continue to play for that clip unless you disable it as well.

A muted clip in the Timeline

Deleting Clips

If you want to completely eliminate one or more clips from the Timeline, select them and press the Delete key. The clip(s) will be removed. If you’ve deleted a clip on Track 1, the Timeline will ripple to close the gap automatically.
Deleting Parts of Clips

If you want to delete only part one or more clips, set In and Out points around the section of the Timeline you want to delete, and press the Delete key. The section of the Timeline between the In and Out points will be removed. If you’ve deleted part of a clip on Track 1, the Timeline will ripple to close the gap automatically.

Trimming Clips

You can also quickly modify your edited timeline by resizing the In and Out points of any clip, moving the edit points between clips, and slipping the contents of a clip.

Resize Clips While Rippling the Timeline

If you move the pointer over the far left or right edge of a clip in the Timeline or Upper Timeline, it turns into a Resize icon to indicate that you can drag the In or Out point of that clip to make it shorter or longer, in the process rippling all clips to the right in the Timeline to accommodate the new length of the clip. While you drag, a tooltip shows you how many frames you’ve moved the clip and the clip’s new duration. As you do so, the audio will scrub along with the Resize cursor.

If you resize a clip in Track 1, the rest of the edited timeline automatically ripples to accommodate the changes you’ve made, with clips to the right of the changed area moving left to fill the gap of a deleted or shortened clips, or moving right to make room for an inserted or lengthened clip.
Moving or resizing clips on Track 2 and above only moves or resizes that one clip; other clips in the Timeline are not rearranged and the Timeline is not rippled when you do this.

**TIP:** When you resize the Out point of a clip on Track 1 that’s underneath a superimposed clip, and the superimposed clip has an In point that’s to the right of the In point of the clip you’re resizing, then dragging the Out point of the clip you’re trimming past the left of the In point of the superimposed clip will delete that superimposed clip from the Timeline.

**Rolling an Edit**

You can click and drag any edit point between two clips in the Timeline or Upper Timeline to “roll” it, basically resizing the Out point of the outgoing clip and the In point of the incoming clip simultaneously. This lets you move an edit point without changing the duration of the overall timeline. While you drag, a white overlay in the Timeline lets you see how much media you have available for rolling (depending on the available handles in the source media). As you do so, the audio will scrub along with the right clip’s In point.
Slipping Clip Content

For each clip in the Timeline, a Slip handle appears at the center of the clip. Dragging this handle lets you slip the contents of that clip to present a different range of media, without changing the position or duration of the clip, and without changing any other part of the Timeline.

You can even select multiple clips, such as two superimposed clips, or a number of clips in a row, and slip them all at the same time. While you drag, a white overlay in the Timeline lets you see how much media you have available for slipping (depending on the source clip’s duration).

Trimming Edits in the Viewer

You can double-click any edit point between two clips in the Timeline or Upper Timeline to open up the Trim Editor, which provides a detailed method of adjusting both halves of an edit point. A graphical A/B roll interface shows two filmstrips with the outgoing clip on top and the incoming clip on the bottom. These controls are draggable:

– Drag the left side of the top filmstrip’s handle to trim the Out point of the outgoing clip
– Drag the right side of the bottom filmstrip’s handle to trim the In point of the incoming clip
– Drag the white handle between the top and bottom filmstrips to roll the edit point, simultaneously adjusting the outgoing and incoming edit points

Numbers over each frame let you see exactly how many frames you’re trimming, while a pair of buttons to the left and right of the transport controls in the Viewer toolbar let you adjust the outgoing clip’s Out point and incoming clip’s In point in one frame increments.
Trimming Transitions in the Viewer

If you double-click a transition, that transition appears sandwiched between the outgoing and incoming clips, with handles you can use to trim the transition’s length, as well as the outgoing and incoming halves of the edit point to which the transition is applied.

The Viewer Trim Editor seen when you double-click a transition in the Timeline
Chapter 29

Using the Inspector in the Cut Page

The Inspector holds all the controls to modify, resize, retime, and generally adjust anything related to a clip, transition, or effect on the Cut page Timeline.

Contents

Using the Inspector 481
Video 481
Audio 487
Effects 488
Transition 489
Image 490
File 491
Using the Inspector

The Inspector has been redesigned to make it easier to find specific controls and to adjust common settings for your clips. Instead of a long vertical list, different aspects of the Inspector have now been organized into panels, with each controlling specific grouped sets of parameters for your clip.

The Inspector is activated by clicking on the Inspector Panel in the upper-right section of the User Interface toolbar. The Inspector is broken up into individual Video, Audio, Effects, Transition, Image, and File panels. Inspector panels that are not applicable to your clip or selection are grayed out.

Methods of using controls in the Inspector:

– **To activate or deactivate a control:** Click the toggle to the left of the control’s name. The orange dot on the right means the control is activated. A gray dot on the left means the control is deactivated.

– **To reveal a control’s parameters:** Double-click the control’s name.

– **To reset controls to their defaults:** Click the reset button to the right of the control’s name.

**Video**

The Video panel of the Inspector exposes a vast array of controls designed to manipulate the size, speed, and opacity of your clips.

**Transform**

The Transform group includes the following parameters for resizing and repositioning your clips:

– **Zoom X and Y:** Allows you to blow the image up or shrink it down. The X and Y parameters can be linked to lock the aspect ratio of the image, or released to stretch or squeeze the image in one direction only.

– **Position X and Y:** Moves the image within the frame, allowing pan and scan adjustments to be made. X moves the image left or right, and Y moves the image up or down.
– **Rotation Angle**: Rotates the image around the anchor point.

– **Anchor Point X and Y**: Defines the coordinate on that clip about which all transforms are centered.

– **Pitch**: Rotates the image toward or away from the camera along an axis running through the center of the image, from left to right. Positive values push the top of the image away and bring the bottom of the image forward. Negative values bring the top of the image forward and push the bottom of the image away. Higher values stretch the image more extremely.

– **Yaw**: Rotates the image toward or away from the camera along an axis running through the center of the image from top to bottom. Positive values bring the left of the image forward and push the right of the image away. Negative values push the left of the image away and push the right of the image forward. Higher values stretch the image more extremely.

– **Flip Image**: Two buttons let you flip the image in different dimensions.
  – **Flip Horizontal control**: Reverses the image along the X-axis, left to right.
  – **Flip Vertical control**: Reverses the clip along the Y-axis, turning it upside down.

**Smart Reframe (Studio Only)**

The Smart Reframe section of the Video Inspector panel

The Smart Reframe feature makes it easier to quickly reframe material across extreme aspect ratio changes. It’s useful for situations where you’ve shot a 16:9 horizontal video and find yourself needing to create a vertically-oriented 9:16 version for mobile phones and social media deliverables, or using 4:3 archival footage in a 2.39:1 widescreen movie. Smart Reframe can be used manually, or automatically executed using the DaVinci Resolve Neural Engine.

– **Object of Interest**: Tools for selecting the subject that the resize will frame around.
  – **Auto**: DaVinci Resolve’s Neural Engine will analyze the clip and choose its most representative object. This will be the only option if more than one clip is selected for Smart Reframing.
  – **Reference Point**: Allows you to manually adjust a bounding box around the subject to reframe around.

– **Reframe**: This button executes the Smart Reframe command. This can take some time depending on the length and number of clips.

**Cropping**

The Cropping section of the Video Inspector panel
The Video Inspector controls the image’s cropping parameters.

- **Crop Left, Right, Top, and Bottom**: Lets you cut off, in pixels, the four sides of the image. Cropping a clip creates transparency so that whatever is underneath shows through.

- **Softness**: Lets you blur the edges of a crop. Setting this to a negative value softens the edges inside of the crop box, while setting this to a positive value softens the edges outside of the crop box.

- **Retain Image Position**: Clicking this checkbox will lock the crop parameters in place when you resize the image using the Transform tool above. Unchecking this box will scale and position the crop as well as the image.

**Dynamic Zoom**

![Dynamic Zoom](image)

The Dynamic Zoom controls, which are off by default, make it fast and easy to do pan and scan effects to zoom into or out of a clip. Turning the Dynamic Zoom group on activates two controls in the Inspector that work hand-in-hand with the Dynamic Zoom onscreen adjustment controls. For more information on using the Dynamic Zoom controls, see Chapter 51, “Compositing and Transforms in the Timeline.”

- **Dynamic Zoom Ease**: Lets you choose how the motion created by these controls accelerates. You can choose from Linear, Ease In, Ease Out, and Ease In and Out.

- **Swap**: This button reverses the start and end transforms that create the dynamic zoom effect.

**Composite**

![Composite](image)

Composite modes can be used to combine clips that are superimposed over other clips in the Timeline.

- **Composite Mode**: This selects the type of composite mode to combine the superimposed clips. The default “Normal” means no compositing mode is applied. For more information on Composite Modes, see Chapter 51, “Compositing and Transforms in the Timeline.”

- **Opacity**: This slider makes a clip more or less transparent in addition to compositing already being done.
Speed Change

The Speed Change controls in the Video Inspector

You can change the speed of your clip directly in the Video Inspector’s Speed Change controls. This method has the benefit of being available in both Cut and Edit pages.

- **Direction**: Selects the desired motion of the clip, forward, backward, or freeze frame.
- **Speed %**: Adjusting this slider changes the clips motion on a percentage basis. This value can be keyframed.
- **Frames Per Second**: Adjusting this slider changes the clips motion by increasing or decreasing the number of frames per second to play the clip back at. This value can be keyframed.
- **Duration**: You can directly select how long you want the clip to be by setting a specific duration here in HH:MM:SS:FF format. This will then automatically adjust the speed of the clip to playback all frames in that exact amount of time.
- **Ripple Sequence checkbox**: If you want the speed change you’re about to make to ripple the Timeline, pushing or pulling all clips following the current one to accommodate the clip’s new size, then turn on this checkbox.
- **Pitch Correction checkbox**: Checking this box will perform pitch correction on the audio attached to the clip so that while the audio duration is changed to match the picture speed, it will still sound natural. Be aware that pitch correction on large speed adjustments may not sound as good as pitch corrections made to small speed adjustments.

Stabilization

The Stabilization section of the Video Inspector panel

These controls let you smooth out or even steady unwanted camera motion within a clip. The analysis is performed in such a way as to preserve the motion of individual subjects within the frame, as well as the overall direction of desirable camera motion, while correcting for unsteadiness.

These are the same stabilizer controls found in the Color page’s Tracker palette (minus the tracker graph), and the resulting stabilization analysis is mirrored on the Color page, where you can see the data visualized on the graph, if necessary.

A pop-up menu provides three different options that determine how the selected clip is analyzed and transformed during stabilization. You must choose an option first, before clicking the Stabilize button.
above, because the option you choose changes how the image analysis is performed. If you choose another option, you must click the Stabilize button again to reanalyze the clip.

- **Perspective**: Enables perspective, pan, tilt, zoom, and rotation analysis and stabilization.
- **Similarity**: Enables pan, tilt, zoom, and rotation analysis and stabilization, for instances where perspective analysis results in unwanted motion artifacts.
- **Translation**: Enables pan and tilt analysis and stabilization only, for instances where only X and Y stabilization gives you acceptable results.
- The other controls let you customize how aggressively the selected clip is stabilized.
- **Stabilization Toggle**: The toggle control for the Stabilization controls lets you turn stabilization off and on to be able to compare the stabilized and unstabilized image.
- **Camera Lock**: Turning on this checkbox disables Cropping Ratio and Smooth, and enables the stabilizer to focus on eliminating all camera motion from the shot in an effort to create a locked shot.
- **Zoom**: When this checkbox is turned on, the image is resized by a large enough percentage to eliminate the blanking (black edges) that is the result of warping and transforming the image to eliminate unwanted camera motion. The lower a value Cropping Ratio is set to, the more DaVinci Resolve will need to zoom into an image to eliminate these blanked edges. If you turn this off, the image is not zoomed at all, and whatever blanking intrudes into the image is output along with the image, on the assumption that you’ll have dedicated compositing artists deal with eliminating this blanking by filling in the missing image data in a more sophisticated manner. You may also leave this checkbox turned off if you’re planning on animating the Input Sizing Zoom parameter to dynamically zoom into and out of a shot being stabilized to eliminate blanking only where it occurs, using only as much zooming as is necessary for each region of the shot.
- **Cropping Ratio**: This value limits how hard the stabilizer tries to stabilize, by dictating how much blanking or zooming you’re willing to accept in exchange for eliminating unwanted motion. A value of 1.0 results in no stabilization being applied. Progressively lower values enable more aggressive stabilization. Changing this value requires you to click the Stabilize button again to reanalyze the clip.
- **Smooth**: Lets you apply mathematical smoothing to the analyzed data used to stabilize the clip, allowing camera motion in the shot while eliminating unwanted jittering. Lower values perform less smoothing, allowing more of the character of the original camera motion to show through, while higher values smooth the shot more aggressively. Changing this value requires you to click the Stabilize button again to reanalyze the clip.
- **Strength**: This value is a multiplier that lets you choose how tightly you want to use the stabilization track to eliminate motion from a shot using the current analysis. With a value of 1, stabilization is maximized. Since some clips might look more natural with looser stabilization, choosing a number lower than 1 lets a percentage of the original camera motion show through. Zero (0) disables stabilization altogether. As an additional tip, you can invert the stabilization by choosing –1 when pasting a stabilization analysis from another clip to perform a match move based on the overall motion of the scene, and you can use a negative value either lower than 0 or higher than –1 to under or overcompensate when inverting the stabilization, simulating the effects of parallax where foreground and background planes move together but at different speeds.

**Lens Correction**

The Lens Correction section of the Video Inspector panel
The Lens Correction group (only available in Resolve Studio) has two controls that let you correct for lens distortion in the image, or add lens distortion of your own.

- **Analyze**: Automatically analyzes the frame in the Timeline at the position of the playhead for edges that are being distorted by wide angle lens. Clicking the Analyze button moves the Distortion slider to provide an automatic correction. If you're analyzing a particularly challenging clip, a progress bar will appear to let you know how long this will take.

- **Distortion**: Dragging this slider to the right lets you manually apply a warp to the image that lets you straighten the bent areas of the picture that can be caused by wide angle lenses. If you clicked the Analyze button and the result was an overcorrection, then dragging this slider to the left lets you back off of the automatic adjustment until the image looks correct.

### Retime and Scaling

The Retime and Scaling section of the Video Inspector panel

The Retime and Scaling group has four parameters that affect retiming quality and clip scale:

- **Retime Process**: Lets you choose a default method of processing clips in mixed frame rate timelines and those with speed effects (fast forward or slow motion) applied to them, on a clip-by-clip basis. The default setting is “Project Settings,” so all speed-effected clips are treated the same way. There are three options: Nearest, Frame Blend, and Optical Flow, which are explained in more detail in the Speed Effect Processing section of Chapter 52, “Speed Effects.”

- **Motion estimation mode**: When using Optical Flow to process speed change effects or clips with a different frame rate than that of the Timeline, the Motion Estimation pop-up lets you choose the best-looking rendering option for a particular clip. Each method has different artifacts, and the highest quality option isn’t always the best choice for a particular clip. The default setting is “Project Settings,” so all speed-effected clips are treated the same way. There are several options. The “Standard Faster” and “Standard Better” settings are the same options that have been available in previous versions of DaVinci Resolve. They’re more processor efficient and yield good quality that are suitable for most situations. However, “Enhanced Faster” and “Enhanced Better” should yield superior results in nearly every case where the standard options exhibit artifacts, at the expense of being more computationally intensive, and thus slower on most systems. The Speed Warp setting is available for even higher-quality slow motion effects using the DaVinci Neural Engine. Your results with this setting will vary according to the content of the clip, but in ideal circumstances this will yield higher visual quality with fewer artifacts than even the Enhanced Better setting.

- **Scaling**: Lets you choose how clips that don’t match the current project resolution are handled on a clip-by-clip basis. The default setting is “Project Settings,” so that all mismatched clips use the same method of being automatically resized. However, you can also choose an individual method of automatic scaling for any clip. The options are Crop, Fit, Fill, and Stretch; for more information see the 2D Transforms section of Chapter 150, “Sizing and Image Stabilization.”

- **Resize Filter**: For clips that are being resized in any way, this setting lets you choose the filter method used to interpolate image pixels when resizing clips. Different settings work better for different kinds of resizing. There are four options:

- **Sharper**: Usually provides the best quality in projects using clips that must be scaled up to fill a larger frame size, or scaled down to HD resolutions.
– **Smoother**: May provide higher quality for projects using clips that must be scaled down to fit an SD resolution frame size.

– **Bicubic**: While the Sharper and Smoother options are slightly higher quality, Bicubic is still an exceptionally good resizing filter and is less processor intensive than either of those options.

– **Bilinear**: A lower quality setting that is less processor intensive. Useful for previewing your work on a low-performance computer before rendering, when you can switch to one of the higher quality options.

– **Other Resize Methods**: A selection of specific resize algorithms is available if you need to match them to other VFX workflows.

### Audio

The Audio Inspector parameters

The Audio tab contains four commonly used audio controls for video editing purposes, including Clip Volume, Clip Pan, Clip Pitch, and Clip Equalizer.

– **Clip Volume**: Each clip has a single volume control that corresponds to the volume overlay over each audio clip.

– **Clip Pan**: (Only exposed for clips) A simple Pan slider that controls stereo panning.

– **Clip Pitch**: Lets you alter the pitch of a clip without changing the speed. Two sliders let you adjust clip pitch in semi tones (large adjustments, a twelfth of an octave) and cents (fine adjustments, 100th of an octave).

– **Clip Equalizer**: Each clip also has a four-band EQ, complete with low-pass, high-pass, and parametric settings for fine tuning and problem-solving audio issues at the clip level.
NOTE: There are many more refined plug-ins and effects for audio clips in the Audio FX library. If you apply any of these, the controls will appear in the Inspector’s Effects tab Audio section, instead of here.

Effects

Any Fusion FX, Open FX, or Audio FX filters that have been applied to a clip can be modified here in their respective tabs. Different effects in the Timeline expose different controls in the Effects panel. Whichever panels are exposed, parameters within each panel are organized into groups, with a title bar providing the name of that group, along with other controls that let you control all parameters within that group at the same time.

These controls include:

- **Enable button**: A toggle control to the left of the parameter group’s name lets you disable and re-enable every parameter within that group at once. Orange means that track’s enabled. Gray is disabled.

- **Parameter group title bar**: Double-clicking the title bar of any group of parameters collapses or opens them. Even more exciting than that, Option-double-clicking the title bar of one parameter group collapses or opens all parameter groups at once.

- **Keyframe and Next/Previous Keyframe buttons**: This button lets you add or remove keyframes at the position of the playhead to or from every single parameter within the group. When the button is highlighted orange, a keyframe is at the current position of the playhead. When it’s dark gray, there is no keyframe. Left and right arrow buttons let you jump the playhead from keyframe to keyframe for further adjustment.

- **Reset button**: Lets you reset all parameters within that group to their default settings.

- **Use Alpha**: Checking this box applies the Open FX alpha channel to the selected clip, compositing it over any background elements that appear in lower tracks. If more than one alpha-modifying effect is applied to a single clip, the alpha channels are mixed together.

For a detailed explanation of each of the Resolve FX plug-ins that accompany DaVinci Resolve, see Part 12, “Resolve FX Overview.”
Double-clicking a transition in the Timeline opens that Transition Panel in the Inspector. Each transition has the following properties you can edit.

- **Transition Type**: The currently selected transition. You can change to any other installed transition by selecting one in the drop-down menu.
- **Duration**: The duration of the transition, shown in both seconds and frames.
- **Alignment**: A drop-down that lets you choose the transition’s position relative to the edit point it’s applied to. Your choices are “Start on Edit,” “Center on Edit,” and “End on Edit.”

Additional properties that are specific to each type of transition appear in another group below. Since the Cross Dissolve transition is the most common transition used, its properties will be shown as an example.

- **Style**: The different Dissolve transitions (Cross Dissolve, Additive Dissolve, and so on) expose this drop-down that lets you choose different ways for the outgoing clip to blend into the incoming clip during the dissolve. There are six different options to choose from:
  - **Video**: A simple linear dissolve; the outgoing clip fades out as the incoming clip fades in.
  - **Film**: A logarithmic dissolve, simulating film dissolves as created by an optical printer.
  - **Additive**: The outgoing and incoming clips are cross faded using the Additive composite mode. As a result, the transition seems to brighten at the halfway point.
  - **Subtractive**: The outgoing and incoming clips are cross faded using the Subtractive composite mode. As a result, the transition seems to darken at the halfway point.
  - **Highlights**: The outgoing and incoming clips are cross faded using the Lighten composite mode. The lightest parts of each clip are emphasized during this transition.
  - **Shadows**: The outgoing and incoming clips are cross faded using the Darken composite mode. The darkest parts of each clip are emphasized during this transition.
- **Start Ratio**: Defines the percentage of completion for the transition at its first frame, from 0 to 100 percent. Setting the Start Ratio to anything but 0 results in the transition immediately appearing at a more fully cross-dissolved state from the very first frame.
- **End Ratio**: Defines the percentage of completion for the transition at its last frame. Setting the End Ratio to anything but 0 results in the transition never fully dissolving to the incoming shot at its last frame.
- **Reverse**: Reverses the transition. This parameter is disabled for Dissolve transitions.
– **Ease:** A drop-down that lets you apply nonlinear acceleration to the beginning, ending, or overall duration of a transition. The result is to add inertia to the transition from the outgoing clip to the incoming clip, providing a gentler change from each clip into and out of the transition.

– **None:** The outgoing clip fades away to the next shot in a linear fashion.

– **In:** The outgoing clip lingers as the beginning of the transition dissolves more slowly than the end.

– **Out:** The outgoing clip fades away more quickly as the beginning of the transition dissolves more quickly than the end.

– **In & Out:** Both the outgoing and incoming clips make slower transitions at the beginning and end of the dissolve, but the very center of the transition is faster as a result.

– **Custom:** Lets you modify the parameters of the fade manually using the Transition Curves below.

– **Transition Curve:** Allows you to manually set keyframes controlling the progress of the transition along its duration.

Other types of transitions display properties that are specific to that transition’s particular effect. For a detailed explanation of each of the transitions that accompany DaVinci Resolve, see Chapter 49, “Using Transitions.”

**Image**

The Image Inspector controls for BRAW footage

The Image panel contains groups of parameters that correspond to every camera raw media format that’s supported by DaVinci Resolve. Using these parameters in the Image panel, you can override the original camera metadata that was written at the time of recording and make simultaneous adjustments to camera raw media throughout your project.

For a detailed explanation of each of the RAW camera parameters supported by DaVinci Resolve, see Chapter 6, “Camera Raw Settings.”
The File Inspector controls a subsection of a clip’s most commonly used media file metadata. It’s easily accessible in the Inspector across the Media, Cut, Edit, and Fairlight pages. The tab is composed of the following parts:

- **Clip Details**: Presents data about the clip’s data format (codec, resolution, frame rate, etc.).
- **Metadata**: Presents a reduced set of common metadata fields for quick user entry.
  - **Timecode**: The start timecode of the clip. This field is editable if you want to manually change the clip’s starting timecode.
  - **Date Created**: The date that the clip was created. This field is editable if you want to manually change the clip’s creation date.
  - **Camera**: Sets the Camera # metadata.
  - **Reel**: Sets the Reel/Card ID.
  - **Scene**: The Scene number of the clip.
  - **Shot**: The Shot letter/number of the clip.
  - **Take**: The Take number of the clip.
  - **Good Take**: This checkbox indicates if the clip is a good or circled take.
  - **Clip Color**: Assign a specific color to a clip that is reflected in the Timeline.
  - **Name**: This can be entered manually, and changes a clip’s name in that specific timeline only.
  - **Comments**: Add a text description to the clip.
- **Auto Select Next Unsorted Clip**: When this box is checked, the next clip in the Media Pool is selected when you hit the Return button after entering a metadata field, and the cursor is automatically placed in the same field. This allows rapid sequential metadata entry without having to manually click to load each individual clip in the Media Pool. The Next Clip button will select the next clip in the Media Pool, regardless of the checkbox status.
Chapter 30

Video and Audio Effects in the Cut Page

As you build your edit, you’ll often find it necessary to add effects to clips to create titles, blend clips together with compositing, add plug-ins to give clips a particular look, speed clips up or slow them down, or transform clips to zoom into them or move them around the frame. The Cut page has controls to accomplish all of this and more.

Contents

Adding Transitions 493
Adding Dissolves 493
Adding Dissolve Using Keyboard Shortcuts 493
Changing a Transition to a Cut 494
Adding Smooth Cuts 494
Adding Other Kinds of Transitions 494
Editing and Removing Transitions 495
Titles 496
Adding Titles 496
Editing Titles 496
Adding Resolve FX and Other Plug-ins 498
Video Effects 498
Audio Effects 498
Generators 498
Clip Tools 499
Shared Controls 499
Transform 499
Crop 500
Dynamic Zoom 500
Composite 501
Speed 501
Stabilization 502
Lens Correction 503
Color 503
Audio 503
Adding Transitions

You can add transitions such as dissolves or wipes to an edit to indicate a change of topic, a change of location, or the passage of time. You can also add a Smooth Cut transition to patch unwanted cuts in interview clips or other situations where there’s not a significant change in the position of the subject or background in the frame. Three buttons, at the bottom right of the Media Pool, make it easy to add and remove dissolves and Smooth Cut transitions.

Adding Dissolves

Dissolves are the most standard and ubiquitous type of transition, and so they’re the easiest to create. Place the playhead on or near an edit you want to turn into a dissolve, and click the Dissolve button at the bottom left of the Media Pool. A one second Cross Dissolve will be added to the edit point that’s nearest to the edit point.

Adding Dissolve Using Keyboard Shortcuts

You can also add a dissolve by selecting one or more edit points (or moving the playhead near an edit you want to select and pressing V to select the nearest edit point), then pressing Command-T to add a dissolve, which is the standard transition.

You can also add a transition that’s aligned with the beginning, middle, or end of the edit point using the keyboard. To do so, select an edit point, press the U key repeatedly to cycle among selecting the start, center, or end of the edit, then press Command-T to add the standard transition. The standard transition will be added with its alignment based on the edit selection you made; selecting the start of the edit places a transition that ends on the edit; selecting the end of the edit places a transition that starts on the edit, and choosing the center of the edit places a transition that is similarly centered.
Changing a Transition to a Cut

To remove a dissolve, thereby changing a transition to a cut, move the playhead at or near the edit with the dissolve, and click the Cut button, which is fast to do when you’re using the DaVinci Resolve Editor Keyboard which has a dedicated Cut button.

**TIP:** Alternately, you can select one or more transitions in the Timeline and press the Delete key to remove them.

Adding Smooth Cuts

Smooth Cuts are special-purpose transitions designed to make short jump cuts in the middle of a clip unnoticeable. This is done by using optical flow processing to match the same features on either side of a cut in order to automatically morph a subject from one position to another over the duration of the transition.

To add a Smooth Cut:

1. Place the playhead on or near an edit.
2. Click the Smooth Cut button at the bottom left of the Media Pool. A one second Smooth Cut will be added to the edit point that’s nearest to the edit point.

The Smooth Cut effect works best on clips such as sit-down interviews and close-up head shots with a minimum of background and subject motion, and where the subject’s position on either side of the cut is not significantly different. A good example of when Smooth Cut is effective is when you’re cutting pauses, partial repeats, filler sounds such as “um” or “you know,” or other speech disfluencies out of an interview clip to tighten the dialog, and you want to eliminate the little “jump” that occurs at the cut without having to cut away to B-roll. Applying a short two or four frame Smooth Cut transition to the edit can make this kind of edit invisible, as long as the speaker doesn’t change position significantly during the cut. The more motion there is in the background of the shot, and the more the speaker changes position, the harder it will be to get a useful result using Smooth Cut. Although the default duration for any transition is one second, you’ll find that Smooth Cut transitions may work much better when they’re short; 2- to 6-frame Smooth Cut transitions often work best to disguise jump cuts.

Adding Other Kinds of Transitions

In order to make the selection of transitions, titles, and effects more intuitive, DaVinci Resolve shows each effect as a thumbnail representation in addition to the text name. This allows the user to quickly scan through all the numerous options to select the appropriate effect visually, rather than remembering them based on name alone. You can preview transitions and titles before you place them on the Timeline to quickly audition multiple options before making your final decision.

Transitions Thumbnails

To preview a transition before you place it into the Timeline, ensure that “Hover Scrub Preview” is checked in the Transitions option menu, then simply hover your pointer over any transition in the Transitions tab and move it across the thumbnail. The transition will preview in the Viewer using the two clips nearest the Smart Indicator in the Cut page, or the two clips nearest the the playhead in the Edit page.
Once you’ve chosen your transition, it can be applied by to any edit point by using the methods below:

**Methods of adding different transitions:**

- **To add a transition by dragging it from the Transitions Browser:** Drag a video transition from the Effects Library to an edit point in the Timeline so that it’s centered at, ends at, or starts at the edit point. If there is no overlap between the heads and tails of the two clips, you may not be able to add a transition where you want.

- **To add a transition using the Transitions Browser’s contextual menu:** Select one or more edit points (one per track), then right-click a video transition in the Effects Library and choose Add to Selected Edit Points. That transition will be added to every selected edit point at once.

- **To add a transition by double-clicking in the Transition Browser:** You can double-click a transition in the Cut page’s Transitions Browser to apply it directly to the edit point referenced by the Smart Indicator.

- **To add a transition by using the transition alignment icons in the Transition Browser:** You can double-click on one of three transition alignment icons at the bottom of the in the Cut page’s Transition Browser.

**Editing and Removing Transitions**

Once you’ve added a transition, you can edit it in a number of different ways to work best for your program, both in the Timeline and in the Transition Inspector.

**Methods of editing transitions in the Timeline:**

- **To change a transition’s duration:** Drag the beginning or end of a transition in the Timeline to be longer or shorter symmetrically about the current edit.

- **To move a transition from one edit to another:** You can drag a transition from its current position to another edit point.

- **To copy a transition from one edit to another:** Select a transition, then option-drag it to another edit point to add a duplicate transition.

- **To change a transition’s type:** Drag a different transition from the Transition Browser onto the current one in the Timeline.

- **To remove a transition:** Select a transition in the Timeline and press the Delete key.

**Editing transitions in the Transition Inspector:**

For more detailed control over your transition, including modifying all transition-specific parameters, use the Transition Inspector. For more information on each specific transition included in DaVinci Resolve, see Chapter 49, “Using Transitions.”
Titles

There’s a collection of title clips in the Titles Browser that you can use to add superimposed titles, slates, interstitial titles, lower thirds, or otherwise fulfill any textual needs your program has.

Titles Thumbnails

To audition titles before you place them into the Timeline, ensure that “Hover Scrub Preview” is checked in the Titles option menu, then simply hover your pointer over any thumbnail in the Titles tab. If the title is animated (i.e., Fusion titles), moving the pointer across the thumbnail will preview the animation. Once you’ve chosen your title, you can drag it from the Titles tab to your Timeline in the Edit page or in the Cut page to either the upper or lower Timelines, or use the editing selection modes at the bottom of the tab.

Two categories present two different kinds of titles. The “Titles” category presents simple, bare-bones titles that you can customize in a variety of different ways. Of the available options, the Text title is the most flexible. The “Fusion Titles” category presents more complicated titles that are more visually sophisticated and have more preset animation.

Adding Titles

You can add a title to the Timeline by opening the Titles Browser and dragging and dropping titles into the Timeline wherever you want them to be, just like any other clip. The default duration of a title clip is 5 seconds. This standard “generator” duration can be customized in the Editing panel of the User Preferences.

Once edited into the Timeline, titles can be moved, resized, and superimposed much like any other clip. Furthermore, when selected, both titles and generators expose the same Transform, Cropping, Speed, and Composite controls as any other clip; these controls can be used to composite titles in various ways to create different text effects.

Editing Titles

Once you add a title to the Timeline, the original title generators that shipped with DaVinci Resolve have onscreen controls that let you edit text and transform and position blocks of text directly within the Timeline Viewer.

Positioning and Transforming Text

So long as the Timeline playhead is positioned over a text generator that’s on top of one or more background clips, clicking on the text in the Timeline Viewer reveals onscreen transform controls that correspond to the Position, Zoom, and Rotation parameters in the Inspector.
While dragging text to reposition it, snapping occurs at the X and Y center of the frame, as well as around the outer third of the frame. Holding the Shift key down while dragging a text object constrains movement to just the X or Y axes. Holding the Option key down turns snapping off.

**Editing Text**

Double-clicking on text in the Timeline Viewer puts that text into an editable state, wherein you can insert a text cursor or select characters to edit the text as you would in any text editor.

**Editing Titles Using the Video Inspector**

For more precise control of your titles, double-clicking on any title will bring up its parameters in the Video Inspector. Here you can change fonts, colors, drop shadows, backgrounds, etc. You can also adjust basic transform parameters and cropping as well. For more information on Editing Titles, see Chapter 50, “Titles, Generators, and Stills.”
Adding Resolve FX and Other Plug-ins

The Effects Browser reveals video and audio plug-ins that you can drag and drop onto your clips. As far as video plug-ins go, there are several categories of Resolve FX plug-ins that accompany DaVinci Resolve, but if you’ve installed Resolve-compatible OFX plug-ins, those appear here as well, organized into their own categories. For audio plug-ins, a set of Fairlight FX plug-ins comes with DaVinci Resolve, but if you’ve installed VST plug-ins on macOS or Windows, or you have Audio Units installed on macOS, those will appear in the Audio category also. When you have a lot of video or audio plug-ins, a search field makes it easy to find the one you’re looking for.

Video Effects

Each available category of video plug-ins creates different sorts of image effects, such as blurs, lighting effects, or stylization of different kinds. To preview a video effect before placing it on a clip, ensure that “Hover Scrub Preview” is checked in the Effects option menu, then simply hover your pointer over any thumbnail in the Effects tab and move it across the thumbnail. The effect will preview in the Viewer using its default parameters, and scrub through the clip that is selected in the Timeline. If no clip is selected then it will use the clip currently under the playhead.

To activate a specific video effect on a clip, simply drag the thumbnail of the selected effect to a clip on the Timeline. In the Cut page, you can also double-click the thumbnail to apply the effect to the selected clip. To adjust the effect’s parameters, open the Effects tab in the Inspector.

Audio Effects

Audio plug-ins let you process your audio in different ways, adjusting the tone using equalization, changing dynamics with compression, or adding effects such as echo, reverb, flange, or modulation. To activate a specific audio effect on a clip, simply drag the thumbnail of the selected effect to a clip on the upper or lower Timelines in the Cut page, or onto a clip in an audio track on the Edit page. Once the effect has been dropped on a clip, its audio plug-in controls will open for you to adjust the plug-in’s parameters.

Generators

The various video generators included in DaVinci Resolve can be previewed by hovering your pointer over any thumbnail in the Generators tab. To edit a generator into your Timeline, simply grab the thumbnail of the generator you wish to use, and place it in your Timeline in the Edit page, or in either the upper or lower Timelines in the Cut page.

For more information on using all the included video and audio effects in DaVinci Resolve, see Chapter 48 "Editing, Adding, and Copying Effects and Filters."
Clip Tools

Clicking the Tools button in the Viewer toolbar opens up additional categories of controls that let you apply various effects to the current clip, or adjust whatever effect is already applied to the current clip. Many of the parameters of these effects have corresponding onscreen controls that let you make visual adjustments directly in the Viewer.

![The Tools button](image)

Shared Controls

Every category of effect at the bottom of the Viewer has two shared controls. A toggle control at the far left lets you enable or disable an effect without losing whatever custom adjustments you’ve made. A reset control at the far right lets you reset every parameter within a particular category of controls to the default settings.

![The Toggle button (at left) and Reset button (at right)](image)

Transform

When you select Transform, onscreen transform controls appear that let you directly manipulate the image in the Viewer. You can drag anywhere within the clip’s bounding box to adjust pan and tilt, drag any diagonal corner to proportionally resize, drag any top/bottom/left/right side to squeeze or stretch width or height, or drag the center handle to rotate.

![Onscreen Transform controls in the Viewer](image)

**TIP:** While dragging a clip using the onscreen controls to reposition it, holding the Shift key down constrains movement to just the X or Y axes.

The onscreen controls also correspond to the following editable parameters, which are also editable in the Video Inspector and in the Edit Sizing mode of the Sizing palette in the Color page:

- **Zoom Width and Height:** Allows you to blow the image up or shrink it down. The X and Y parameters can be linked to lock the aspect ratio of the image, or released to stretch or squeeze the image in one direction only.

- **Position X and Y:** Moves the image within the frame, allowing pan and scan adjustments to be made. X moves the image left or right, and Y moves the image up or down.

- **Rotation Angle:** Rotates the image around the anchor point.
– **Pitch:** Rotates the image toward or away from the camera along an axis running through the center of the image, from left to right. Positive values push the top of the image away and bring the bottom of the image forward. Negative values bring the top of the image forward and push the bottom of the image away. Higher values stretch the image more extremely.

– **Yaw:** Rotates the image toward or away from the camera along an axis running through the center of the image from top to bottom. Positive values bring the left of the image forward and push the right of the image away. Negative values push the left of the image away and bring the right of the image forward. Higher values stretch the image more extremely.

– **Flip Image:** Two buttons let you flip the image in different dimensions.
  – **Flip Horizontal control:** Reverses the image along the X axis, left to right.
  – **Flip Vertical control:** Reverses the clip along the Y axis, turning it upside down.

### Crop

The Cut page has a set of onscreen controls you can use to directly crop the image in the Viewer. Each side of the image has an individual handle for cropping just that side. These parameters are also editable in the Video Inspector and the Color page Sizing palette.

![Onscreen Crop controls in the Viewer](image)

The Crop effects also correspond to an additional set of cropping parameters, with an additional control for softness:

– **Crop Left, Right, Top, and Bottom:** Lets you cut off, in pixels, the four sides of the image. Cropping a clip creates transparency, so whatever is underneath shows through.

– **Softness:** Lets you blur the edges of a crop. Setting this to a negative value softens the edges inside of the crop box, while setting this to a positive value softens the edges outside of the crop box.

### Dynamic Zoom

The Dynamic Zoom controls, which are off by default, make it fast and easy to do pan and scan effects to zoom into or out of a clip. A set of two onscreen controls let you create a Dynamic Zoom effect. A green box shows the starting size and position of the animated transform, while a red box shows the ending size and position of the animated transform. Drag anywhere within either bounding box to reposition either the start or the end of the animated effect, and drag any of the corners to adjust the size at the start or end. A motion path appears to show you motion that’s being created. Adjusting the Dynamic Zoom controls automatically enables dynamic zoom. These controls are also available in the Video Inspector.

![Dynamic Zoom controls in the Viewer](image)

These controls correspond to two parameters in the toolbar (Dynamic Zoom is also editable in the Video Inspector).
– **Zoom/Pan/Angle Presets**: Let you enable or disable preset positions for the zoom level, pan location, and angle of this effect.

– **Swap**: This button reverses the start and end transforms that create the dynamic zoom effect.

– **Ease Buttons**: Lets you choose how the motion created by these controls accelerates. You can choose from Linear, Ease In, Ease Out, and Ease In and Out.

**TIP**: While dragging dynamic zoom outlines to reposition them, holding the Shift key down constrains movement to just the X- or Y-axis.

### Composite

Two controls let you create transparency and use composite modes to create different compositing effects (also called Blend modes or Transfer modes). These controls also editable in the Video Inspector.

– **Composite Modes**: Composite modes blend two superimposed clips together on the Timeline using different kinds of math to achieve differing results, to create transparency effects, increase image exposure, and combine multiple clips into a single image in many creative and useful ways. All Composite modes interact with the Opacity slider. For more information on what each Composite mode does, see Chapter 51, “Compositing and Transforms in the Timeline.”

– **Opacity**: This slider lets you make a clip more transparent, over a range from 0 (totally transparent) to 100 (totally opaque). When set to a value less than 100, the selected clip is mixed with whatever video clip is underneath it on the Timeline, using the Composite mode that’s currently selected. If no clip appears underneath the Timeline, then the clip is mixed with black and will work similarly to a fade.

**TIP**: If a superimposed video or still image clip in the Timeline has an alpha channel, that alpha channel automatically creates transparency within that clip, compositing it against whatever is in the track underneath. There’s no need for you to do anything for this to work.

### Speed

Speed effects let you speed up, slow down, or otherwise change the playback speed of clips in the Timeline. When you change the speed of a clip, that clip’s duration also changes to reflect a shorter clip that plays faster, or a longer clip that plays more slowly. Speed effects change both video and audio playback, but the audio of sped up or slowed down clips is always pitch corrected. Speed effects applied in the Cut page also appear and are editable via several different methods in the Edit page timeline and the Video inspector.
– **Speed:** Changing this value lets you speed up or slow down playback by a simple numeric multiplier. You also have the option of choosing a negative value to create reverse speeds.

– **Duration:** When you retime a clip, the Duration field lets you see how the change you’re making affects the new duration based on the original duration of the clip with no speed effect applied.

### Stabilization

The Image Stabilization controls use warping and/or translation to let you smooth out or even lock unwanted camera motion within a clip. The analysis is performed in such a way as to preserve the motion of individual subjects within the frame, as well as the overall direction of desirable camera motion, while correcting for unsteadiness.

![Stabilization controls in the Viewer](image)

To stabilize an image, all you need to do is to choose a Stabilization Method from the drop-down (see below for more information), and then click the Stabilize button. DaVinci Resolve analyzes the current clip, and applies a stabilization effect.

The rest of the stabilization controls let you refine the result. Whenever you adjust any of these parameters, you must click the Stabilize button again for the effect to be updated.

– **Stabilization Method:** A drop-down menu provides three different options that determine how the selected clip is analyzed and transformed during stabilization. You must choose an option first, before clicking the Stabilize button, because the option you choose changes how the image analysis is performed. If you choose another option, you click the Stabilize button again to reanalyze the clip.

  – **Perspective:** Enables perspective, pan, tilt, zoom, and rotation analysis and stabilization.

  – **Similarity:** Enables pan, tilt, zoom, and rotation analysis and stabilization, for instances where perspective analysis results in unwanted motion artifacts.

  – **Translation:** Enables pan and tilt analysis and stabilization only, for instances where only X and Y stabilization gives you acceptable results.

– **Stabilize:** Clicking this button on a previously unstabilized clip analyzes the motion in that clip and applies an initial smoothing effect. Clicking this button on a clip that’s already been analyzed lets you recalculate a modified stabilization effect.

**TIP:** These controls are identical to those found in the Video Inspector and the Color page Tracker palette, and populate the same image processing data. This means that you can use the Stabilization found on the Cut page, and then use the stabilization graph and controls found in the Color page to refine the results, if necessary.
Lens Correction

Lens Correction presents two controls that let you either correct lens distortion in the image, or add lens distortion of your own for effect. These controls are also editable in the Video Inspector and Color page Edit Sizing palette.

Lens Correction controls in the Viewer

- **Analyze**: Automatically analyzes the frame in the Timeline at the position of the playhead for edges that are being distorted by wide angle lens. Clicking the Analyze button moves the Distortion slider to provide an automatic correction. If you're analyzing a particularly challenging clip, a progress bar will appear to let you know how long this will take.

- **Distortion**: Dragging this slider to the right lets you manually apply a warp to the image that lets you straighten the bent areas of the picture that can be caused by wide angle lenses. If you clicked the Analyze button and the result was an overcorrection, then dragging this slider to the left lets you back off of the automatic adjustment until the image looks correct.

Color

The Color section of the Tools consists of only one option: Auto Color. The Auto Color command provides a quick way to automatically balance the blacks and whites of a clip based on the current frame at the position of the playhead. Using advanced algorithms, based on the DaVinci Neural Engine, it provides superior results when automatically adjusting color balance and contrast. For more details on using Auto Color, see Chapter 127, “Automated Grading Commands and Imported Grades.”

Color controls in the Viewer

Audio

A slider lets you adjust audio levels of the current clip in the Viewer, making the volume of that audio clips softer or louder. This is identical to each clip’s volume setting in the Edit and Fairlight pages.

Audio controls in the Viewer
Chapter 31

Quick Export

Once you’ve finished your program and you want to share it with others, you can use the Quick Export button to output the contents of the Timeline as a self-contained file in one of a variety of different formats in order to share it with people.

Contents

Quick Export 505
Customizing Quick Export 505
Quick Export

You can choose File > Quick Export to use one of a variety of export presets to export your program from any page of DaVinci Resolve. You can even use Quick Export to export and upload your program to one of the supported video sharing services, including YouTube, Vimeo, and Frame.io.

To use Quick Export:
1. In the Edit, Fusion, or Color page, optionally set In and Out points in the Timeline to choose a range of the current program to export. If no timeline In or Out points have been set, the entire timeline will be exported.
2. Choose File > Quick Export or click the Quick Export icon at the upper right-hand corner of the Cut page.
3. Select a preset to use from the top row of icons in the Quick Export dialog, and click Export.
4. Choose a directory location and enter a file name using the Export dialog, then click Save. A progress bar dialog appears to let you know how long the export will take.

Customizing Quick Export

While the Quick Export has, by default, a variety of the most important formats currently in use for sharing video files, you may need to export to a format that’s not in this dialog. In this case, there are ways of creating additional presets and having them appear in the Quick Export dialog.

To customize Quick Export:
1. Open the Deliver page.
2. Create the preset you want to add using the Render Settings panel.
3. Click the Render Settings panel’s Option menu and choose the preset or presets you want to add from the Quick Exports submenu so that they’re checked. You can also remove your own presets from the Quick Export window by unchecking them in this menu.

TIP: For more export options, you can also use the Deliver page.
The DaVinci Resolve Editor Keyboard is a combination of Keyboard and Edit Controller that greatly enhances your speed and efficiency working in DaVinci Resolve.

Contents

Introducing the DaVinci Resolve Editor Keyboard 507
Navigation Using the Search Dial 508
Sort Media Pool Buttons 509
Editorial Tools 510
Trimming Tools 514
Transition Keys 515
Function Keys 516
Timecode Entry 520
QWERTY Keyboard Commands 522
Editor Keyboard Function (Fn) Key Map 523
Updating the Editor Keyboard Firmware 523
Introducing the DaVinci Resolve Editor Keyboard

Using a traditional keyboard and mouse to edit with is necessary for modern computers, as the interface and operating system dictate the use of these input tools. However, the mouse can sometimes feel like an abstraction in the editing process, and the DaVinci Resolve Editor Keyboard has been designed to bring back a more “hands on” feel. This keyboard allows the convenience and power of non-linear editing with the tactile nature of the tape-based edit controllers of the past.

This hybrid editing style is based around the concept of the “timeline edit point.” An edit point is simply the junction between two edit points that is closest to the playhead on the Timeline. This edit point can either be before or after the playhead, and the playhead does not need to be on the actual point itself, just near it. DaVinci Resolve’s Cut Page will automatically assume the edit point for you, and shows you where it intends to make the edit using a Smart Indicator, which looks like a small arrow on the Timeline Ruler.

The Cut page Timeline’s Smart Indicator (circled) showing the timeline edit point.

The key to making this style of editing fast and efficient is the speed at which you arrive at these timeline edit points. The DaVinci Resolve Editor Keyboard has been designed to greatly accelerate timeline navigation and to use a two-handed workflow with dedicated buttons for common functions in order to keep your mouse use to a minimum.

The DaVinci Resolve Editor Keyboard
Navigation Using the Search Dial

The most prominent feature of the DaVinci Resolve Editor Keyboard is the large Search Dial on its right hand side. Primarily used for navigation, in certain circumstances this dial can also be used for the manipulation of the clips, providing an alternative to click and drag mouse input.

Since navigation of the Timeline is where most editors spend the majority of their time, you will want to decide on how the playhead reacts on the Timeline. In the Cut page you have two options: Lock or Free Playhead.

– When set to Locked, the playhead is fixed in the center of the Timeline, and your edited clips scroll past it as you play (press the Spacebar), jog, or shuttle with the Search Dial in either direction. Locked mode is preferred while using the DaVinci Resolve Editor Keyboard.

– When set to Free, the playhead moves across the clips as you play (press the Spacebar), jog, or shuttle using the Search Dial in either direction; the clips stay still. Once the playhead gets to the right or left edge of the Timeline, the Timeline pages over to reveal the next part of your edit.

Source
Pressing this button instantly brings the Source Viewer into focus, allowing you to navigate through the source media.

Timeline
Pressing this button instantly brings the Timeline Viewer into focus, allowing you to navigate through the Timeline.

SHTL (Shuttle)
Puts the Search Dial into Shuttle mode. Used to quickly navigate long clips or sync bins. Rotating the dial left of center “rewinds” through the clip or timeline, rotating it right “fast forwards” through them. The greater the rotation from center, the faster the Shuttle goes. There are hard end stops on the Search Dial in Shuttle mode that indicate the maximum speed in either direction. A LED on the keyboard will illuminate to show you that this mode is selected.
Jog
Puts the Search Dial into Jog mode. Used to navigate to specific frames with accuracy and precision. Traditionally, you place your finger in the search dial dimple, and rotate it to the left to go frame by frame reverse, and to the right to go frame by frame forward. In Jog mode the hard stops are released, and the wheel rotates freely in a complete circle. A LED on the keyboard will illuminate to show you that this mode is selected.

SCRL (Scroll)
Puts the Search Dial into Scroll mode. Scroll mode is essentially a “higher geared” jog mode. Rotating the wheel left reverses the play direction, while rotating it right moves forward. Scroll works in terms of seconds rather than frames. The speed at which you rotate the Search Dial determines how fast the playhead moves through the footage. A LED on the keyboard will illuminate to show you that this mode is selected.

**TIP:** As a rule of thumb, Shuttle is most effective at the scene level, Jog at the clip level, and Scroll at the timeline level.

## Sort Media Pool Buttons

These buttons allow you to instantly re-configure the Media Pool view to arrange your clips in a specific order.

![The Media Pool Sort buttons](image)

**Timecode**
Pressing this button will instantly sort all of the clips in the Media Pool by Timecode. Pressing this button again will toggle between ascending and descending order.

**CAM (Camera)**
Pressing this button will instantly sort all of the clips in the Media Pool by Camera Number order. The camera numbers can be set in the Clips Metadata Editor field “Camera #”. This field can either be a number or a letter. Pressing this button again will toggle between ascending and descending order.

**Date/Time**
Pressing this button will instantly sort all of the clips in the Media Pool by the Date and Time that the clip was created. Pressing this button again will toggle between ascending and descending order.
Clip Name
Pressing this button will instantly sort all of the clips in the Media Pool by Clip Name. Please note this sorts media by the user selected Clip Name, not the media's File Name that is recorded in camera. Pressing this button again will toggle between ascending and descending order.

**TIP:** Changing the Media Pool Sort buttons re-arranges the Source Tape on the fly. This allows you to instantly re-order your Media Pool clips while viewing them with the Search dial.

Editorial Tools
The DaVinci Resolve Editor keyboard has dedicated keys to perform common editing functions, in addition to the standard QWERTY keyboard.

The Cut page Editing tools

In
This button selects the In point of a clip or timeline.

Out
This button selects the Out point of a clip or timeline.

Smart Insert
Automatically inserts an incoming clip at the closest edit point to the playhead (as shown by the Smart Indicator) on the selected track, pushing all clips to the right of the edit point forward to make room for the incoming clip you’ve inserted to Track 1. Because this is a smart operation, you are prevented from inserting a clip at any arbitrary frame; incoming clips are only inserted at the closest previously existing edit point.
Append

The position of the playhead is ignored; incoming clips are always placed after the last clip in the Timeline.

RIPL O/WR (Ripple Overwrite)

At its simplest, Ripple Overwrite substitutes a clip in the Timeline with an incoming clip. If you use Ripple Overwrite on a clip on Track 1, this will automatically move all clips that are to the right of the affected clip in the Timeline either forward to make room if the incoming clip is longer, or back to eliminate gaps if the incoming clip is shorter.

TIP: Using Ripple Overwrite is an efficient way to audition different takes of the same shot without disrupting the narrative flow of the entire scene.
Close Up

Lets you edit a clip into the Timeline as a zoomed-in close up to make up for a lack of actual close ups that would have been shot with either longer lenses or by moving the camera closer to the subject. This function is particularly useful when you’re working with 4K media in a 1080 timeline, or 8K media in a 4K timeline, which enables you zoom into existing wide shots to create medium shots, or medium shots to create close up shots, with no loss of quality.

Performing this edit adds the incoming clip as an approximate 150% scaled close up, also performs a face detection, and if a face or faces are found, automatically re-positions the face in the frame. Which frame of the Timeline the incoming clip aligns with depends on the following:

– If no In or Out points are set on the Timeline, the incoming clip aligns with the Timeline playhead as the In point.
– The incoming clip aligns with a timeline In point if one has been set.
– The incoming clip’s Out point will align with a timeline Out point if one has been set without an In point. This “backtimes” the clip.

(Top) Before a Close Up edit, (Bottom) After editing clip DD into the Timeline with a Close Up edit

Place On Top

Lets you edit the incoming clip as a superimposition above whatever other clips are in the Timeline; the incoming clip is always placed on top, so if there are clips in Tracks 1, 2, and 3, the incoming clip is automatically placed on Track 4, regardless of which track is selected. The frame the incoming clip aligns with depends on the following:

– The incoming clip aligns with the closest Timeline edit point in proximity to the playhead (as shown by the Smart Indicator) if no timeline In or Out points have been defined. The playhead is ignored.
– The incoming clip aligns with a timeline In point if one has been set.
– The incoming clip’s Out point will align with a timeline Out point if one has been set without an In point. This “backtimes” the clip.

(Top) Before placing a clip on top, (Bottom) After editing clip DD into the Timeline with a Place on Top edit
SRC O/WR (Source Overwrite)

This edit requires overlapping timecode in multiple clips to work properly, such as when recording synced timecode to multiple cameras during a multi-cam shoot. If there is no overlapping timecode, this edit does nothing.

If you are working with footage from multiple cameras that have synced timecode, then the easiest way to use this edit type is to set In and Out points over a clip in the Timeline where you want to cut away to another angle. In the following example, a wide shot of a cooking show covers the moment when the chef starts slicing a chili.

Setting timeline In and Out points to identify a cutaway

You can then select a clip in the Media Pool that corresponds to the desired angle you want to add as a cutaway, which has synced timecode that overlaps with the clip in the Timeline. Don’t set In and Out points; if necessary, you can clear previously set In and Out points by pressing Option-X.

Choosing a Media Pool clip from another camera that has overlapping timecode

When you click the Source Overwrite button, a synced section of the selected Media Pool clip will be edited into the Timeline between the In and Out points you placed, superimposed on top. The result is a perfectly timed cutaway.
Alternatively, you can also use Source Overwrite to automatically place a source clip with a marked In/Out region on top of a clip in the Timeline so that its timecode syncs with the timecode of the timeline clip, when you don’t know exactly how much of the incoming source clip you want to edit into the Timeline, and you just want it synced appropriately.

## Trimming Tools

Several of the most powerful features of the DaVinci Resolve Editor Keyboard involve the intuitive trimming controls afforded by the Search dial.

### Trim In

When this key is pressed and held, it lets the user trim the nearest In point on the Timeline (as shown by the Smart Indicator), by simply rotating the Search dial back and forth. The trim point is highlighted in green. Release the key to confirm the edit.

### Trim Out

When this key is pressed and held, it lets the user trim the nearest Out point on the Timeline (as shown by the Smart Indicator), by simply rotating the Search dial back and forth. The trim point is highlighted in green. Release the key to confirm the edit.

### Roll

When this key is pressed and held, it lets the user trim the nearest transition point (as shown by the Smart Indicator), and roll the edit point back and forth between the clips by simply rotating the Search dial. The trim point is highlighted in green. Release the key to confirm the edit.

### SLIP SRC (Slip Source)

When this key is pressed and held, it allows the user to slip the footage of the clip to the left of the Smart Indicator back and forth by moving the Search dial. A four way multiview will show the In and Out points for both source and destination clips as you slip. The clip that will slip will be highlighted in orange. Release the key to confirm the edit.

### SLIP DEST (Slip Destination)

When this key is pressed and held, it allows the user to slip the footage of the clip to the right of the Smart Indicator back and forth by moving the Search dial. A four way multiview will show the In and Out points for both source and destination clips as you slip. The clip that will slip will be highlighted in orange. Release the key to confirm the edit.
**Trim Editor**

This button near the Timecode keypad places the Cut page into the Trim Editor mode in the Viewer. The current transition point is highlighted in green. You can navigate from transition point to transition point in the Timeline by rotating the Search dial. Pressing the U key will cycle through the edit point types for your trim.

*TIP:* It’s important to remember in using the Trim tools that the playhead position over a clip is not a selection. Only the Smart Indicator will determine where the In/Out points are set for trimming. If you find you are often misjudging the Trim points, a press of the Up Arrow or Down Arrow will likely get you where you want to be.

**Transition Keys**

This set of keys provide immediate shortcuts to the most commonly used transition commands.

**Cut**

This key will change any existing transition to a simple cut at the Timeline edit point, as shown by the Smart Indicator. It will not add a new cut at the playhead position. To do this use the Split Clip (Command-) function instead.

**DIS (Dissolve)**

This key will add a one second dissolve centered between the two shots at the Timeline edit point, as shown by the Smart Indicator. If there is another transition already present there, it will replace it.

**SMTH CUT (Smooth Cut)**

This key will add a Smooth Cut transition centered between the two shots at the Timeline edit point, as shown by the Smart Indicator. If there is another transition already present there, it will replace it.

Smooth Cuts are special-purpose transitions designed to make short jump cuts in the middle of a clip unnoticeable. This is done by using optical flow processing to match the same features on either side of a cut in order to automatically morph a subject from one position to another over the duration of the transition.

The Smooth Cut effect works best on clips such as sit-down interviews and close-up head shots with a minimum of background and subject motion, and where the subject’s position on either side of the cut is not significantly different. A good example of when Smooth Cut is effective is when you’re cutting
pauses, partial repeats, filler sounds such as “um” or “you know,” or other speech disfluencies out of an interview clip to tighten the dialog, and you want to eliminate the little “jump” that occurs at the cut without having to cut away to B-roll. Applying a short two or four frame Smooth Cut transition to the edit can make this kind of edit invisible, as long as the speaker doesn’t change position significantly during the cut. The more motion there is in the background of the shot, and the more the speaker changes position, the harder it will be to get a useful result using Smooth Cut. Although the default duration for any transition is one second, you’ll find that Smooth Cut transitions may work much better when they’re short; 2- to 6-frame Smooth Cut transitions often work best to disguise jump cuts.

**TRANS DUR (Transition Duration)**

Holding down this key when a transition is under the Smart Indicator will allow you to change the duration of the transition using the Search dial. Turning the dial left will shorten the transition, and right will lengthen it. Once the duration is correct, release the button.

**TIP:** Multiple transitions can be changed at the same time by holding down Command and selecting the transitions on the Upper Timeline, then pressing the appropriate transition key (CUT, DIS, SMTH CUT).

### Function Keys

The function keys of the DaVinci Resolve Editing Keyboard are by default mapped directly to their DaVinci Resolve commands. If you wish to use them as regular function keys (f1, f2, f3, etc.) you can hold the Fn key down and press the appropriate function key.

![Function Keys Diagram]

**Sync Bin (F1)**

This key will open up the Sync Bin for easy multi-camera editing as described in Chapter 27, “Fast Editing in the Cut Page.” There is, however, a specific function in the Sync Bin that works only with the DaVinci Resolve Editing Keyboard, called Live Overwrite.

**Live Overwrite**

When editing in the Sync Bin you can “paint on” a specific camera angle to the Timeline and adjust its duration using the Search dial.
1 Navigate the Timeline so the playhead is where you want the new camera angle to start. This function does not edit at the Smart Indicator; the edit point is exactly where the playhead is positioned.

2 Hold down the number of the camera you want in the multi viewer on the keyboard, and rotate the Search dial to the right to adjust the duration forward or to the left to go backward. The video and audio of the clip will be laid down as you move the Search dial. If a video only edit is selected, the timeline audio will play underneath the live overwrite as its happening.

3 Release the number key to perform the edit.

At this point the Timeline is instantly set up at the correct point to do the next edit, so repeat Step 2 and Step 3 again with different camera angles until you are finished.

This is an incredibly quick and intuitive way to edit multi-camera productions.

Insert Black (F2)
Pressing this button will add two seconds of black (via the solid color generator) to the selected track. This is used as filler for transitions where you want to replace the “nothing” of the empty timeline with an actual media clip. This function does not use the Smart Indicators and will insert exactly at the playhead position.

Freez (Freeze Frame) (F3)
Pressing this button will freeze the exact frame of the clip that is under the playhead for the remaining duration of that clip.
**TRANS (Transition) (F4)**
Holding down this key brings up a drop-down menu of your available transitions in alphabetical order and an icon describing their shape. Rotating the Search dial left and right will navigate you through the list. When you find the transition that you want, simply release this key and it will be placed at the Timeline edit point as shown by the Smart Indicator.

![Drop-down Transition menu](image)

**Pic in Pic (Picture in Picture) (F5)**
Holding this button down will open a drop-down menu that displays four picture-in-picture placement options that you can navigate using the Search dial or numeric keyboard. This function will take the media that is in the Source Viewer, scale it to 1/8 size and place it on top of the original clip in the position that was selected in the drop-down menu. If you wish to change the drop-down position, navigate over the clips, hold down this button and select another position.

![Picture-in-Picture options](image)

**Swap (F6)**
Press and hold the Swap button, and using the Search dial, move the clip under the playhead earlier or later in the Timeline, effectively swapping the moving clip with the one you are scrolling over.
Video Only (F7)
This button locks the audio tracks in place on the Timeline so that all further editing is done with the video tracks only. Press this button again to release the audio tracks, or press the Audio Only button.

Audio Only (F8)
This button locks the video tracks in place on the Timeline so that all further editing is done with the audio tracks only. Press this button again to release the video tracks, or press the Video Only button.

Insert (F9)
An Insert edit splits whatever media is already in the Timeline at the position of the playhead and pushes that media to the right to make room for the incoming clip.

O/WR (Overwrite) (F10)
You can use the F10 key to perform an Overwrite edit, which overwrites a section of the Timeline with the incoming clip, without moving other clips in any way. The frame the incoming clip aligns with depends on the following:

- The incoming clip aligns with the playhead if no timeline In or Out points have been defined.
- The incoming clip aligns with a timeline In point if one has been set.
- The incoming clip’s Out point will align with a timeline Out point if one has been set without an In point. This “backtimes” the clip.

REPL (Replace) (F11)
Replace edits are a unique three-point edit type that aligns the frame at the Source Viewer playhead with the frame at the Timeline playhead when the edit is executed. This is the fastest edit type to use when you need to align an action at a specific frame of video, or a sound at a specific frame of audio, to a particular frame’s action or sound in the video or audio of the Timeline.

The fastest way of using the Replace edit is to not bother setting either In or Out points in the Source Viewer, and to either use the duration of an existing clip intersecting the Timeline to define the edit, or a pair of timeline In/Out points specifying either a section of a clip you want to overwrite, or an empty section of the Timeline to which you want to edit.

Replace edits do not ripple the Timeline.

Fit to Fill (F12)
Fit to fill edits are the only edit type that actually use all four edit points, and it’s the only edit type that retimes clips at the same time as they’re being edited. By setting In and Out points in the incoming source clip, and another pair of In and Out points in the Timeline, you can stretch or compress the timing of the specified range of source media to cover the entire specified range of the Timeline. In the process, the speed ratio of the clip changes so the clip plays in either fast or slow motion.

Fit to fill edits are especially valuable when you have a source clip in which the action is slightly slow, and you just want to speed it up by squeezing it into a shorter duration of the Timeline. They’re also incredibly handy in situations when you have a gap in an edited sequence of clips to fill with a source clip that’s just not long enough, but in which slightly slower motion won’t be noticeable.

Fit to fill edits do not ripple the Timeline.

Ripple Del (Ripple Delete)
Pressing this key will delete the selected clip or clips, and then close any gaps that occur by rippling the Timeline to the left.
Timecode Entry

This numerical keypad has many timecode-specific keys that allow you to input these values directly into DaVinci Resolve to navigate to specific points in the Timeline, or move forward and backward in the Timeline by specific increments.

How to Enter Timecode Values

When entering timecode, type each pair of hour, minute, second, and frame values from left to right, with a period representing a pair of zeros for fast entry. The numbers you enter appear in the timecode field at the upper right-hand corner of the Viewer with focus. When you’re finished typing, press the Return key to execute the Timecode command. The rules for timecode entry are as follows:

- The right-most pair of timecode values (or period) you enter is always the frame number.
- A period to the left or to the right of any number you type is considered to be a pair of zeroes.
- A single period between two numbers is considered to either be a single zero, or ignored if it’s between two pairs of numbers.
- Any untyped pairs of values to the left of what you enter are assumed to be whatever those values were prior to the timecode you entered; this makes it easy to type partial timecode values even when the Timeline starts at hour one.
- It’s not necessary to enter colons or semicolons.

Absolute Timecode Entry

Absolute timecode is entered simply by typing in a timecode value. So long as no clips or edit points are selected when you press the Return key, the playhead will move to that timecode value. If an edit point or clip is selected, those will be moved or trimmed to the corresponding timecode value, if possible.
Here are some examples of absolute timecode entry using this method:

<table>
<thead>
<tr>
<th>Original TC Value</th>
<th>User-Typed Value</th>
<th>New TC Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>01:10:10:10</td>
<td>15245218</td>
<td>15:24:52:18</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>2...</td>
<td>01:02:00:00</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>15</td>
<td>01:10:10:15</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>12</td>
<td>01:10:10:12</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>1.2</td>
<td>01:10:01:02</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>1115..</td>
<td>11:15:00:00</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>23...</td>
<td>23:00:00:00</td>
</tr>
</tbody>
</table>

Relative Timecode Entry
Relative timecode is entered by starting the timecode value with a plus (+) or minus (–). Adding a plus results in the value you type being added to the current timecode value for purposes of offsetting the playhead or moving a selection. Adding a minus will subtract the value you type from the current timecode value.

Here are two examples of relative timecode entry:

<table>
<thead>
<tr>
<th>User-Typed Value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>+20.</td>
<td>00:00:20:00 is added to the current timecode value.</td>
</tr>
<tr>
<td>+3..</td>
<td>00:03:00:00 is added to the current timecode value.</td>
</tr>
<tr>
<td>-5</td>
<td>00:00:00:05 is subtracted from the current timecode value.</td>
</tr>
</tbody>
</table>

F/TC (Frames/Timecode)
This button toggles between timecode (HH:MM:SS:FF) and frame count (23, 48, etc.) entry using the numerical keypad. For example, if you wanted to move forward 200 frames, you can press this key and then enter +200 and press the Enter key.

Dur Enter (Duration Enter)
Press this key to quickly change the duration of a transition or clip length to the exact number that you typed in.

00
This button adds two zeros to the timecode input rather than a single zero, to make numerical entry faster.

**TIP:** You can set the duration of multiple clips at the same time (for example, a set of graphics) by Command selecting all clips you want to change, typing in the new duration you want the clips to be on the keypad, then pressing the DUR ENTER (Duration Enter) key.
QWERTY Keyboard Commands

The standard QWERTY shortcut keys have been modified slightly.

**Retime (R)**
The Retime controls have been mapped to the letter R on the keyboard. This works both in the Cut and Edit pages.

**Full View (P)**
The full screen Viewer has been mapped to the letter P on the keyboard, and works in the Cut, Edit, Color and Fusion pages.

**Hand (H)**
This key allows you to select Hand or Pointer mode on the Viewer for repositioning of titles. This works on the Edit page only.

**Zoom (Z)**
This key will zoom to fit your media clip in the Viewer. This works in the Cut, Edit, and Color pages.

**Autocolor (C)**
This key will perform the Autocolor function on the clip that is underneath the playhead, or the selected timeline clip.

**Using the Function (Fn) Key on the Editor Keyboard**
There are three types of key actions mapped to the DaVinci Resolve Editor Keyboard. The Function (Fn) key in the lower left of the keyboard toggles these modes and each type of key action modifies the resulting commands. These key actions give you access to standard computer functions in your native OS.

- **Key Press:** Simply pressing the key once.
- **Fn + Key Press:** Holding down the Fn key and then pressing another key.
- **Tap Fn + Hold:** Pressing the Fn Key once, then pressing Fn again and holding it down, then pressing another key. This is a total of three key presses.
Editor Keyboard Function (Fn) Key Map

<table>
<thead>
<tr>
<th>Key Press</th>
<th>Fn + Key Press</th>
<th>Tap Fn + Hold</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYNC BIN</td>
<td>F1</td>
<td>DECREASE SCREEN BRIGHTNESS</td>
</tr>
<tr>
<td>INSERT BLACK</td>
<td>F2</td>
<td>INCREASE SCREEN BRIGHTNESS</td>
</tr>
<tr>
<td>FREEZ</td>
<td>F3</td>
<td>SHOW ALL WINDOWS</td>
</tr>
<tr>
<td>TRANS</td>
<td>F4</td>
<td>SHOW ALL APPLICATIONS</td>
</tr>
<tr>
<td>PIC IN PIC</td>
<td>F5</td>
<td>DECREASE KEYBOARD LED BRIGHTNESS</td>
</tr>
<tr>
<td>SWAP</td>
<td>F6</td>
<td>INCREASE KEYBOARD LED BRIGHTNESS</td>
</tr>
<tr>
<td>VIDEO ONLY</td>
<td>F7</td>
<td>PREVIOUS TRACK</td>
</tr>
<tr>
<td>AUDIO ONLY</td>
<td>F8</td>
<td>PLAY/PAUSE</td>
</tr>
<tr>
<td>INSERT</td>
<td>F9</td>
<td>NEXT TRACK</td>
</tr>
<tr>
<td>O/WR</td>
<td>F10</td>
<td>MUTE</td>
</tr>
<tr>
<td>REPL</td>
<td>F11</td>
<td>DECREASE VOLUME</td>
</tr>
<tr>
<td>FIT TO FILL</td>
<td>F12</td>
<td>INCREASE VOLUME</td>
</tr>
<tr>
<td>UP ARROW</td>
<td>PAGE UP</td>
<td>PAGE UP</td>
</tr>
<tr>
<td>DOWN ARROW</td>
<td>PAGE DOWN</td>
<td>PAGE DOWN</td>
</tr>
<tr>
<td>LEFT ARROW</td>
<td>HOME</td>
<td>HOME</td>
</tr>
<tr>
<td>RIGHT ARROW</td>
<td>END</td>
<td>END</td>
</tr>
<tr>
<td>HOME</td>
<td>END</td>
<td>END</td>
</tr>
<tr>
<td>KEYPAD ENTER</td>
<td>CALCULATOR</td>
<td>CALCULATOR</td>
</tr>
<tr>
<td>DELETE</td>
<td>FORWARD DELETE</td>
<td>FORWARD DELETE</td>
</tr>
<tr>
<td>CAM</td>
<td>PRINT SCREEN</td>
<td>PRINT SCREEN</td>
</tr>
<tr>
<td>TIMECODE</td>
<td>PAUSE</td>
<td>PAUSE</td>
</tr>
<tr>
<td>DUR ENTER</td>
<td>NUM LOCK</td>
<td>NUM LOCK</td>
</tr>
</tbody>
</table>

Updating the Editor Keyboard Firmware

From time to time, Blackmagic updates the functionality of the Editor Keyboard through firmware changes. New firmware can be checked for and installed by opening the separate DaVinci Control Panels Setup utility that is installed by default with DaVinci Resolve.
The DaVinci Resolve Speed Editor is an edit controller designed specifically to work hand-in-hand with the Cut page.

Contents

Introducing the DaVinci Resolve Speed Editor 525
Using the Speed Editor Keys 525
Navigation Using the Search Dial 525
Intelligent Keyboard Edit Modes 527
Search Dial Live Trimming Tools 531
Transition Keys 532
Function Keys 533
Sync Bin Multi Camera Selection 536
Live Overwrite Mode 536
Updating the Speed Editor Firmware 539
Introducing the DaVinci Resolve Speed Editor

The DaVinci Resolve Speed Editor is specifically designed for custom integration with the Cut page. It efficiently combines transport control, editing functions, and multi-camera support into a powerful edit controller with a small footprint.

Using the Speed Editor Keys

To maximize the functionality of all the keys on this reduced-sized edit controller, there are four different finger actions used to modify a key’s commands:

- **Press**: A short tap to the key and release, as if you were typing.
- **Double Press**: Two short taps to the key and release. The double press triggers the secondary function of the key that is written on the lower side of the keycap.
- **Press and Hold**: Tap the key and hold it down.
- **Double Press and Hold**: One short tap, and then tap again and hold the key down.

Navigation Using the Search Dial

The most prominent feature of the DaVinci Resolve Speed Editor is the large Search Dial on its right hand side. Primarily used for navigation, in certain circumstances this dial can also be used for parameter selection and the direct manipulation of the clips, providing an alternative to click and drag mouse input.
Since navigation of the Timeline is where most editors spend the majority of their time, you will want to decide on how the playhead reacts on the Timeline. In the Cut page you have two options: Lock or Free Playhead.

- When set to Locked, the playhead is fixed in the center of the Timeline, and your edited clips scroll past it as you play (press the Spacebar), jog, or shuttle with the Search Dial in either direction. Locked mode is preferred while using the DaVinci Resolve Speed Editor.

- When set to Free, the playhead moves across the clips as you play (press the Stop/Play bar), jog, or shuttle using the Search Dial in either direction; the clips stay still. Once the playhead gets to the right or left edge of the Timeline, the Timeline pages over to reveal the next part of your edit.

### SOURCE
Pressing this key instantly brings the Source Tape into focus, allowing you to navigate through all the source media in your bin.

### TIMELINE
Pressing this key instantly brings the Timeline Viewer into focus, allowing you to navigate through the Timeline.

### SHTL (Shuttle)
Puts the Search Dial into Shuttle mode. Used to quickly navigate long clips or sync bins. Rotating the dial left of center “rewinds” through the clip or timeline, rotating it right “fast forwards” through them. The greater the rotation from center, the faster the Shuttle goes. A LED on the keyboard will illuminate to show you that this mode is selected.

### JOG
Puts the search dial into Jog mode. Used to navigate to specific frames with accuracy and precision. Traditionally, you place your finger the the search dial dimple, and rotate it to the left to go frame-by-frame reverse, and to the right to go frame-by-frame forward. The faster you rotate the search dial, the faster the navigation. A LED on the keyboard will illuminate to show you that this mode is selected.
SCRL (Scroll)

Puts the search dial into Scroll mode. Scroll mode is essentially a “higher geared” Jog mode. Rotating the wheel left reverses the play direction, while rotating it right moves forward. Scroll works in terms of seconds, rather than frames. The speed at which you rotate the search dial determines how fast the playhead moves through the footage. A LED on the keyboard will illuminate to show you that this mode is selected.

TIP: As a rule of thumb, Shuttle is most effective at the scene level, Jog the clip level, and Scroll at the timeline level.

Intelligent Keyboard Edit Modes

The DaVinci Resolve Speed Editor has dedicated keys to perform common editing functions.

IN / CLR

This key selects the In Point of a clip or timeline. Double press this key (CLR) to clear the In point.

OUT / CLR

This key selects the Out point of a clip or timeline. Double press this key (CLR) to clear the Out point.

If you are viewing a bin in the Source tape, you can use the In and Out buttons to limit the Source tape between the two points. This allows you to quickly reduce the Source tape to a specific section, regardless of how many clips are in your bin.

To reduce the Source tape based on In and Out points:

1. In the Source tape, set the newly desired duration using the In and Out keys on the Speed Editor.
2. Press the “Source” key.
3. The Source tape is now limited to the duration between the two points.
4. If you wish to return to the original full Source tape, press the “Esc” key.

SMART INSRT (Smart Insert) / CLIP

Automatically inserts an incoming clip at the closest edit point to the playhead (as shown by the Smart Indicator) on the selected track, pushing all clips to the right of the edit point forward to make room for
the incoming clip you've inserted to Track 1. Because this is a smart operation, you are prevented from inserting a clip at any arbitrary frame; incoming clips are only inserted at the closest previously existing edit point.

Double Press this key (CLIP) to Smart Insert the entire source clip, ignoring any In and Out points previously set on the clip.

![Smart Insert Example]

**APPND (Append) / CLIP**

The position of the playhead is ignored; incoming clips are always placed after the last clip in the Timeline.

Double Press this key (CLIP) to append the entire source clip, ignoring any In and Out points previously set on the clip.

![Append Example]

**RIPL O/WR (Ripple Overwrite)**

At its simplest, Ripple Overwrite substitutes a clip in the Timeline with an incoming clip. If you use Ripple Overwrite on a clip on Track 1, this will automatically move all clips that are to the right of the affected clip in the Timeline either forward to make room, if the incoming clip is longer, or back to eliminate gaps, if the incoming clip is shorter.

![Ripple Overwrite Example]
**TIP:** Using Ripple Overwrite is an efficient way to audition different takes of the same shot without disrupting the narrative flow of the entire scene.

**CLOSE UP / YPOS**

Pressing this key reframes a clip as a zoomed-in close up to make up for a lack of actual close ups that would have been shot with either longer lenses, or by moving the camera closer to the subject. This function is particularly useful when you’re working with 4K media in a 1080 timeline, or 8K media in a 4K timeline, which enables you zoom into existing wide shots to create medium shots, or medium shots to create close up shots, with no loss of quality.

Performing this edit adds the incoming clip as an approximate 20% to 40% zoomed close up and also performs a face detection. If a face or faces are found, it automatically re-positions the face top center in the frame. You can always reposition the close up manually using the Sizing controls in the Inspector.

Press and Hold this key (YPOS) to adjust the Y position of the Clip using the search dial.

How this key works depends on the mode that is active in the Cut page.

- **Source mode:** The selected clip in the Source Tape view is edited into the Timeline as a close up, duration based on the In and Out points set in the clip, and the Smart Indicator on the Timeline.
- **Timeline mode:** The clip under the playhead has a Close Up applied to it, and is copied to the track above it, with a 5 second duration starting from the playhead position.
- **Live Overwrite mode:** This will perform a Close Up on the selected camera as it’s overwritten into the Timeline.

The LED on this key will then illuminate, to show you that this mode is armed.

**PLACE ON TOP**

This key lets you edit the incoming clip as a superimposition above whatever other clips are in the Timeline; the incoming clip is always placed on top, so if there are clips in Tracks 1, 2, and 3, the incoming clip is automatically placed on Track 4, regardless of which track is selected.

The frame the incoming clip aligns with depends on the following:

- The incoming clip aligns with the closest Timeline edit point in proximity to the playhead (as shown by the Smart Indicator) if no Timeline In or Out points have been defined. The playhead is ignored.
- The incoming clip aligns with a Timeline In point if one has been set.
- The incoming clip’s Out point will align with a timeline Out point if one has been set without an In point. This “backtimes” the clip.
**SRC O/WR (Source Overwrite)**

This edit requires overlapping timecode in multiple clips and Track 1 of the Timeline to work properly, such as when recording synced timecode to multiple cameras during a multi-cam shoot. If there is no overlapping timecode, this edit does nothing.

If you are working with footage from multiple cameras that have synced timecode, then the easiest way to use this edit type is to set In and Out points over a clip in the Timeline where you want to cut away to another angle. In the following example, a wide shot of a cooking show covers the moment when the chef starts slicing a chili.

![Setting timeline In and Out points to identify a cutaway](image)

You can then select a clip in the Media Pool that corresponds to the desired angle you want to add as a cutaway, which has synced timecode that overlaps with the clip on Track 1 in the Timeline. Don’t set In and Out points; if necessary, you can clear previously set In and Out points by pressing Option-X.

![Choosing a Media Pool clip from another camera that has overlapping timecode](image)

When you click the Source Overwrite key, a synced section of the selected Media Pool clip will be edited into the Timeline between the In and Out points you placed, superimposed on top. The result is a perfectly timed cutaway.

![Using Source Overwrite to edit a superimposed and synced section of the source clip into the Timeline between the In/Out points](image)
Alternatively, you can also use Source Overwrite to automatically place a source clip with a marked In/Out region on top of a clip in the Timeline so that its timecode syncs with the timecode of the Timeline clip, when you don’t know exactly how much of the incoming source clip you want to edit into the Timeline, and you just want it synced appropriately.

**Search Dial Live Trimming Tools**

Several of the most powerful features of the DaVinci Resolve Speed Editor involve the intuitive trimming controls afforded by the search dial.

**TRIM IN**

When this key is pressed and held, it lets the user trim the nearest In point on the Timeline (as shown by the Smart Indicator), by simply rotating the search dial back and forth. The trim point is highlighted in green. Release the key to confirm the edit.

In Source mode, holding this key and rotating the search dial adjusts the In Point of the clip in the Viewer.

**TRIM OUT**

When this key is pressed and held, it lets the user trim the nearest Out point on the Timeline (as shown by the Smart Indicator), by simply rotating the search dial back and forth. The trim point is highlighted in green. Release the key to confirm the edit.

In Source mode, holding this key and rotating the search dial adjusts the Out Point of the clip in the Viewer.

**ROLL / SLIDE**

When this key is pressed and held, it lets the user trim the nearest transition point (as shown by the Smart Indicator), and roll the edit point back and forth between the clips by simply rotating the search dial. The trim point is highlighted in green. Release the key to confirm the edit.

Double Press and Hold this key (SLIDE) to Slide the entire clip back and forth in the Timeline. A four-way multiview will show the In and Out points for both source and destination clips as you slide.

**SLIP SRC (Slip Source)**

When this key is pressed and held, it allows the user to slip in place the footage of the clip to the left of the Smart Indicator back and forth by moving the search dial. A four-way multiview will show the In and Out points for both source and destination clips as you slip. The clip that will slip will be highlighted in orange. Release the key to confirm the edit.
**SLIP DEST (Slip Destination)**

When this key is pressed and held, it allows the user to slip in place the footage of the clip to the right of the Smart Indicator back and forth by moving the search dial. A four-way multiview will show the In and Out points for both source and destination clips as you slip. The clip that will slip will be highlighted in orange. Release the key to confirm the edit.

**TRANS DUR (Transition Duration) / SET**

Holding down this key when a transition is under the Smart Indicator will allow you to change the duration of the transition using the search dial. Turning the dial left will shorten the transition, and right will lengthen it. Once the duration is correct, release the key.

Double Pressing this key (SET) allows you to set the current transition length as the default transition duration.

**TIP:** Multiple transitions can be changed at the same time by holding down Command and selecting the transitions on the Upper Timeline, then pressing the appropriate transition key (CUT, DIS, SMTH CUT).

---

**Transition Keys**

This set of keys provide immediate shortcuts to the most commonly used transition commands.

---

**CUT**

This key will change any existing transition to a simple cut at the Timeline edit point, as shown by the Smart Indicator. It will not add a new cut at the playhead position. To do this use the Split Clip (Command-) function instead.

The LED on this key will illuminate to show you the Cut Transition is armed in Live Overwrite mode.

**DIS (Dissolve)**

This key will add a one second dissolve centered between the two shots at the Timeline edit point, as shown by the Smart Indicator. If there is another transition already present there, it will replace it.

The LED on this key will illuminate to show you the Cut Transition is armed in Live Overwrite mode.
SMTH CUT (Smooth Cut)
This key will add a Smooth Cut transition centered between the two shots at the Timeline edit point, as shown by the Smart Indicator. If there is another transition already present there, it will replace it.

The LED on this key will illuminate in Live Overwrite mode to show you the Cut Transition is armed.

Smooth Cuts are special-purpose transitions designed to make short jump cuts in the middle of a clip unnoticeable. This is done by using optical flow processing to match the same features on either side of a cut in order to automatically morph a subject from one position to another over the duration of the transition.

The Smooth Cut effect works best on clips such as sit-down interviews and close-up head shots with a minimum of background and subject motion, and where the subject’s position on either side of the cut is not significantly different. A good example of when Smooth Cut is effective is when you’re cutting pauses, partial repeats, filler sounds such as “um” or “you know,” or other speech disfluencies out of an interview clip to tighten the dialog, and you want to eliminate the little “jump” that occurs at the cut without having to cut away to B-roll. Applying a short two- or four-frame Smooth Cut transition to the edit can make this kind of edit invisible, as long as the speaker doesn’t change position significantly during the cut. The more motion there is in the background of the shot, and the more the speaker changes position, the harder it will be to get a useful result using Smooth Cut. Although the default duration for any transition is one second, you’ll find that Smooth Cut transitions may work much better when they’re short; 2- to 6-frame Smooth Cut transitions often work best to disguise jump cuts.

Function Keys

ESC / UNDO
This key functions the same way as the escape key on your keyboard, but in the Cut page it is also used to clear a selected camera in the Sync Bin.

Double press this key (UNDO) to undo your last action. Multiple double-presses take you back through the Undo history.

SYNC BIN
This key will open up the Sync Bin for easy multi-camera editing. For more information on using the Sync Bin see Chapter 27, “Fast Editing in the Cut Page” in the DaVinci Resolve Reference Manual.
Distance Indicators to Adjacent Edits

When using the Speed Editor’s search dial while using the Sync Bin, the Cut page playhead in the lower timeline now has two small windows to either side showing the distance to the nearest edit. The left window shows the time to the nearest previous edit, and the right window shows the time to the next previous edit. Both windows are in seconds:frames (SS:FF) format. This feature allows you to quickly jump to, or modify an edit point using the direct timecode entry method.

![Distance Indicators](image)

The Distance Indicators when using the Search Dial in the Sync Bin. The left window is showing one second and ten frames to the previous edit, and the right window is showing thirty three frames to the next edit as shown by the smart indicator.

 AUDIO LEVEL / MARK

Press and holding the Audio Level key allows you to adjust the selected clip’s Volume parameter by rotating the Search dial. If no clip is selected it will modify the clip on the highest track under the playhead.

Double pressing this key (MARK) adds a marker placed at the playhead’s current position. Double press again to enter the marker’s editing dialog box to add comments, durations, etc.

Double press and holding this key allows you to set the color of the marker before you add it, by rotating the search dial.

![Audio Level/Mark](image)

Double pressing and holding down the Audio level/Mark key brings up a rotary marker color selector that you can navigate with the search dial.

 FULL VIEW / RVW

Pressing this key expands the Viewer to Full View mode on the interface monitor. Pressing this key again returns the Viewer to its normal mode.

Double press this key (RVW) to review your edit. This function plays back a pre-roll before and post-roll after the last edit in Full View mode. The pre- and post-roll time durations can be set in the Editing section of the User tab in the DaVinci Resolve preferences.
TRANS / TITLE
Press and hold this key to bring up a drop-down menu of your available transitions in alphabetical order and an icon describing their shape. Rotating the search dial left and right will navigate you through the list. When you find the transition that you want, simply release this key and it will be placed at the Timeline edit point as shown by the Smart Indicator.

Double press and hold this key (TITLE) to modify the font of an existing title. If the playhead is over a basic title and this key is held, you can rotate the search dial to change the font of the title. This only modifies the first text element in a title. Once you’ve selected your font, release the key to set it.

The LED on this key will illuminate to show you the Standard Transition is armed in Live Overwrite mode.

SPLIT / MOVE
Press this key to create a new cut in a clip at the playhead position. The cut will affect all clips under the playhead if more than one track is being used.

If the playhead is over an existing split, pressing this key will remove the split and join the two parts of the clip back together.

Double press this key (MOVE) to move your selected clip in the Timeline. Using the search dial, you can move the clip backwards and forwards in the Timeline from edit to edit. The Timeline will reflow to adapt to your clip placement. When you find the place you want to move your clip to, release the key to set it.

SNAP / (Viewer Resize)
Press this key to enable the Snapping mode designed specifically for the search dial. With snap turned on in Jog mode, and when the search dial is rotated very slowly, the playhead will briefly pause at each edit point in the Timeline. This key has an LED to show you when this mode is active.

Double press and hold this key (Three Lines) to dynamically resize the Viewer window using the search dial. Rotating the dial to the left increases the Viewer size, and to the right decreases it.

RIPL DEL (Ripple Delete)
Pressing this key will delete the selected clip or clips, and then close any gaps that occur by rippling the Timeline to the left. If no clip is selected, this key will ripple delete the clip under the playhead.
Sync Bin Multi Camera Selection

**VIDEO ONLY**
Press this key to only allow the video from your source clip into a video track on the Timeline. This key has an LED to tell you when it is active. Press this key again to deactivate.

**AUDIO ONLY**
Press this key to only allow the audio from your source clip into an audio track the Timeline. This key has an LED to tell you when it is active. Press this key again to deactivate.

**STOP/PLAY**
This key starts and stops playback on your Timeline or source media. It’s conveniently arranged for using your thumb, while your fingers are on the search dial.

**CAM 1-9**
These keys only function in Sync Bin view. Each camera key allows you to choose its corresponding camera angle as active in the Sync Bin. Pressing any Camera key will expand that camera angle into the Source Clip view, making it easy to set specific In and Out points and perform edit functions. You can change camera angles instantly in the Source Clip view by simply pressing another Camera key. If you wish to return to the Sync Bin view, press the Escape key.

These keys illuminate and have a switcher-like function in Live Overwrite mode, as explained below.

**Live Overwrite Mode**

The Live Overwrite mode in the Speed Editor can be thought of as switching a live Multicam shoot without all the annoying constraints of linear time. With all the camera angles locked together in the Sync Bin, you can perform and trim all the edits, transitions, and camera switches, you want and never go out of sync. Every edit you make will be perfectly synchronized to the Timeline automatically.
LIVE O/WR (Live Overwrite Mode) / RND (Random)

Press this key to enter Live Overwrite mode. An LED will illuminate to tell you this mode is active. It immediately activates the Sync Bin and the Multicam Viewer, and switches the Speed Editor into a different mode, slightly changing the functionality of several keys to accommodate the Live Overwrite workflow. A key that is in Live Overwrite mode has an LED light illuminate to let you know that the key’s function is currently active.

Double Press this key (RND) to edit a Random camera angle with a random duration into the Timeline from the Sync Bin.

Using Live Overwrite Mode

Editing Multicamera shoots in Live Overwrite mode starts with the base layer on track V1. The clip you put here has two additional functions other than its video content. First, it provides a continuous timecode track that is the foundation of all the Sync Bin functionality. Second, it provides content to measure all of the ripple functions against.

NOTE: Live Overwrite Mode only works with clips in the Sync Bin. If there are no clips set in the Sync Bin, this mode will not function. For more information on setting up the Sync Bin, see Chapter 27, “Fast Editing in the Cut Page,” in the DaVinci Resolve Reference Manual.
A good starting point is to place your master camera angle, uninterrupted from beginning to end on track V1. You will be able to edit this track, remove whole sections, and re-arrange it as necessary later in the process, but for now, this master clip on V1 will serve as the backbone of the edit.

Once the master clip of the Sync Bin is on V1, you can start using the Live Overwrite mode in earnest. The concept to understand about Live Overwrite is that this method of editing bypasses traditional In and Out points all together, and edits are performed with the Camera keys working in conjunction with the Search Dial.

Performing a Live Overwrite edit:

1. Press the Live O/WR button to activate the mode. The LED on the key will illuminate.
2. Use the search dial to navigate the Sync Bin to where you want to make an edit (switch camera angles). You will notice all cameras and the Timeline will move together in sync.
3. Select a camera angle in the Multicam Viewer you wish to edit in, and press and hold the corresponding Camera key on the Speed Editor, while rotating the search dial forward. This will edit in a new clip on top of the V1 track, and you can use the search dial to immediately set its duration.
4. Release the Camera key to set the edit.

From here you can immediately press and hold another Camera key and rotate the search dial to continue the Multicam edit. You can think of this method as “painting-on” clips to the Timeline, rather than inserting them. Clips edited in this fashion will never overwrite other clips on the same track. Live Overwrite will always add the clip to the next highest track, and create a new track automatically if necessary.
Continuing the edit from here does not require working in a linear fashion. Because the master track is on V1, you can skip ahead anywhere on the Timeline and start “painting-in” camera angles wherever you wish, and because the Timeline and Source clips are locked together in the Sync Bin, whatever edit you add will always be in perfect sync.

**Live Overwrite Mode Key Modifiers:**
Selecting Live Overwrite mode subtly changes the functions of many keys on the Speed Editor, so they work in conjunction with this mode. Each of these keys has an LED that illuminates to tell you the function is active before you perform a Live Overwrite edit.

- **CUT:** Automatically adds a simple cut to the beginning of each clip edited to the Timeline. This option is also effectively no transition added.

- **DIS:** Automatically adds a Cross Dissolve transition to the beginning of each clip edited to the Timeline. If the edited clip is immediately adjacent to another clip on the same track, the dissolve will be centered on the cut. If there is no clip immediately adjacent, the dissolve will start on the edit instead, and dissolve from the video on the track underneath the clip.

- **SMTH CUT:** Automatically adds a Smooth Cut transition to the beginning of each clip edited to the Timeline. If the edited clip is immediately adjacent to another clip on the same track, the Smooth Cut will be centered on the cut. If there is no clip immediately adjacent, the Smooth Cut will start on the edit instead, and Smooth Cut from the video on the track underneath the clip.

- **TRANS:** Automatically adds whatever transition is set as the “Standard Transition” in the Transitions panel to the beginning of each clip edited to the Timeline. If the edited clip is immediately adjacent to another clip on the same track, the transition will be centered on the cut. If there is no clip immediately adjacent, the transition will start on the edit instead, and transition from the video on the track underneath the clip.

- **CLOSE UP:** Automatically performs a Close Up action on the camera as its edited into the Timeline.

**Updating the Speed Editor Firmware**

From time to time, Blackmagic updates the functionality of the Speed Editor through firmware changes. New firmware can be checked for and installed by opening the separate DaVinci Control Panels Setup utility that is installed by default with DaVinci Resolve.
In this chapter, you’ll learn how to use and configure the Edit page user interface to prepare for editing projects in DaVinci Resolve. For more information on how to use the Edit page to import and conform projects edited in other applications for color correction and finishing in DaVinci Resolve, see Chapter 57, “Conforming and Relinking Clips.”

Contents

**The Edit Page User Interface** 543
**Navigating the Edit Page** 544
**Showing Which Panel Has Focus** 544
**The Media Pool** 544
**Importing Media Into the Media Pool on the Edit Page** 545
**Bins, Power Bins, and Smart Bins** 546
**Showing Bins in Separate Windows** 546
**Filtering Bins Using Color Tags** 547
**Sorting the Bin List** 548
**More About Timelines and Grading** 549
**Timelines, Grades, and Versions** 549
**Enabling the Use of a Master Timeline** 549
**Using the Effects Library** 551
**The Toolbox** 551
**OpenFX** 552
**Audio FX** 552
**Effects Library Favorites** 552
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Index</td>
<td>553</td>
</tr>
<tr>
<td>Navigating the Timeline Using the Edit Index</td>
<td>553</td>
</tr>
<tr>
<td>Edit Index Columns</td>
<td>553</td>
</tr>
<tr>
<td>Filtering the Edit Index</td>
<td>555</td>
</tr>
<tr>
<td>Exporting the Edit Index</td>
<td>555</td>
</tr>
<tr>
<td>Source and Timeline Viewers</td>
<td>556</td>
</tr>
<tr>
<td>How Each Clip’s Grade Looks in Each Viewer</td>
<td>556</td>
</tr>
<tr>
<td>Source and Timeline Viewers vs. Single Viewer Mode</td>
<td>557</td>
</tr>
<tr>
<td>Viewer Controls</td>
<td>558</td>
</tr>
<tr>
<td>Simultaneous Audio Waveform Display in the Source Viewer</td>
<td>561</td>
</tr>
<tr>
<td>Cinema Viewer Mode</td>
<td>561</td>
</tr>
<tr>
<td>Viewer Indicators</td>
<td>561</td>
</tr>
<tr>
<td>Other Viewer Options</td>
<td>562</td>
</tr>
<tr>
<td>Fast Review in the Timeline Viewer</td>
<td>562</td>
</tr>
<tr>
<td>Opening Clips in the Source Viewer</td>
<td>562</td>
</tr>
<tr>
<td>Timeline Viewer Edit Overlays</td>
<td>563</td>
</tr>
<tr>
<td>Copy and Paste Timecode in Viewer Timecode Fields</td>
<td>563</td>
</tr>
<tr>
<td>Metadata Editor</td>
<td>564</td>
</tr>
<tr>
<td>Inspector</td>
<td>565</td>
</tr>
<tr>
<td>Timeline</td>
<td>565</td>
</tr>
<tr>
<td>Timeline Options</td>
<td>567</td>
</tr>
<tr>
<td>Switching Among Multiple Timelines</td>
<td>569</td>
</tr>
<tr>
<td>Toolbar</td>
<td>569</td>
</tr>
<tr>
<td>Toolbar Audio Monitoring Controls</td>
<td>571</td>
</tr>
<tr>
<td>The Mixer and Meters</td>
<td>571</td>
</tr>
<tr>
<td>Displaying Audio Meters</td>
<td>572</td>
</tr>
<tr>
<td>Using Video Scopes</td>
<td>572</td>
</tr>
<tr>
<td>Floating Timecode Window</td>
<td>573</td>
</tr>
<tr>
<td>Dual Monitor Layout</td>
<td>573</td>
</tr>
<tr>
<td>Customizing the Edit Page</td>
<td>574</td>
</tr>
<tr>
<td>Undo and Redo in DaVinci Resolve</td>
<td>575</td>
</tr>
</tbody>
</table>
The Edit Page User Interface

The Edit page has evolved into a source-record style NLE that contains nearly every editorial tool you need for creative editing through finishing. The Edit page is divided into three main regions: the browsers found at the left, the Viewers at the top, and the Timeline at the bottom, all of which work together to let you import, edit, and trim timelines with a flexible variety of tools and methods.

The Interface Toolbar

At the very top of the Edit page is a toolbar with buttons that let you show and hide different parts of the user interface. These buttons are as follows, from left to right:

- **Media Pool/Effects Library/Edit Index height button**: Lets you set the area used by the Media Pool, Effects Library, and/or Edit Index to take up the full height of your display (you can display two at a time), giving you more area for browsing at the expense of a narrower timeline. At half height, the Media Pool/Effects Library/Edit Index are restricted to the top of the UI (you can only show one at a time), and the timeline takes up the full width of your display.
- **Media Pool**: Opens or hides a smaller version of the full Media Pool page, allowing access to all the video clips, audio clips, and images used in the project.
- **Effects Library**: Opens or hides the repository of all transitions, generators, OpenFX, and audio filters available to use in the Edit page.
- **Edit Index**: Opens or hides the list of all edit events in enabled tracks of the Timeline.
- **Sound Library**: Opens or hides the databases of sound effects and music registered with DaVinci Resolve. For more information on using the Sound Library, see Chapter 167, “Using the Fairlight Page.”
- **Mixer**: Opens or hides the Audio Mixer, giving you graphical controls to adjust your sound mix.
- **Metadata**: Hides or shows the Metadata Editor.
- **Inspector**: Shows or hides the Inspector, which shows you the transform and compositing effects of selected clips, or the editable options of selected effects such as transitions or generators.
Navigating the Edit Page

Each of the panels in the Edit page user interface can be given focus via the Workspace > Active Panel Selection submenu. Additionally, the following keyboard shortcuts can be used to give focus to select bins, clips, the Source and Timeline Viewers, the Timeline, the Effects Library, Edit Index, and Inspector.

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command-1</td>
<td>Media Folders</td>
</tr>
<tr>
<td>Command-2</td>
<td>Media Clips</td>
</tr>
<tr>
<td>Command-3</td>
<td>Source Viewer</td>
</tr>
<tr>
<td>Command-4</td>
<td>Timeline</td>
</tr>
<tr>
<td>Command-5</td>
<td>Timeline Viewer</td>
</tr>
<tr>
<td>Command-6</td>
<td>Effects</td>
</tr>
<tr>
<td>Command-7</td>
<td>Edit Index</td>
</tr>
<tr>
<td>Command-8</td>
<td>n/a</td>
</tr>
<tr>
<td>Command-9</td>
<td>Inspector</td>
</tr>
<tr>
<td>Q</td>
<td>Toggle between Source and Timeline Viewers</td>
</tr>
</tbody>
</table>

Showing Which Panel Has Focus

Each panel you use has “focus,” meaning that clicking an item or control within a particular panel makes that panel the active panel, which serves to direct keyboard shortcuts that are shared among many panels to the particular panel you’re using. If you want to see which panel is in focus, you can turn on the “Show focus indicators in the User Interface” checkbox in the UI Settings panel of the User Preferences. When on, a red line at the top of the active panel indicates that it has focus.

The Media Pool

In the Edit page, the Media Pool contains all of the video, audio, and still image media you’ve imported for editing into the project at hand, as well as all of the timelines that you’re going to be editing into. The Media Pool is also mirrored on the Media, Cut, Fusion, Color, and Fairlight pages, so you can access any audio or video clip, graphic, or timeline from any page where they can be used.

The Bin list at the left shows a hierarchical list of bins used for organizing your media, which is also used to organize your timelines. By default, the Media Pool consists of a single bin, named “Master,” but you can add more bins as necessary to organize timelines and clips by right-clicking anywhere in the empty area of the Media Pool and choosing Add Bin. You can rename any custom bin by double-
clicking on its name and typing a new one, or by right-clicking a bin’s name and choosing Rename Bin. The Bin list can be hidden or shown via the button at the upper left-hand corner of the Edit page toolbar.

The Media Pool in Thumbnail mode, shown in half-height mode

The browser area to the right shows the contents of the currently selected folder. Every timeline you create, and every AAF, XML, or EDL file you import, appears here. You can create or import as many timelines as you need within a single project.

As in the Media page, the Media Pool can be displayed in either Metadata, Icon, or List view. In List view, you can sort the contents by any one of a subset of the total metadata that’s available in the Metadata Editor of the Media page. Of particular interest to editors are columns for Name, Reel Name, different timecode streams, Description, Comments, Keyword, Shot, Scene, Take, Angle, Circled, Start KeyKode, Flags, Usage, Resolution, and Frames Per Second.

For more information on using the myriad features of the Media Pool, see Chapter 17, “Adding and Organizing Media with the Media Pool.” In the sections that follow, some key features of the Media Pool are summarized for your convenience.

**Importing Media Into the Media Pool on the Edit Page**

While adding clips to the Media Pool in the Media page provides the most organizational flexibility and features, if you find yourself in the Edit, Cut, Fusion, Color, or Fairlight page and you need to quickly import a few clips for immediate use, you can do so in a couple of different ways.

To add media by dragging one or more clips from the Finder to the Edit page Media Pool (macOS only):

1. Select one or more clips in the Finder.
2. Drag those clips into the Media Pool of DaVinci Resolve or to a bin in the Bin list.

Those clips are added to the Media Pool of your project.
To use the Import Media command in the Edit page Media Pool:

1. With the Edit page open, right-click anywhere in the Media Pool, and choose Import Media.
2. Use the Import dialog to select one or more clips to import, and click Open.

Those clips are added to the Media Pool of your project.

For more information on using the myriad features of the Media Pool, see Chapter 17, “Adding and Organizing Media with the Media Pool.” Below, some key features of the Media Pool are summarized for your convenience.

Bins, Power Bins, and Smart Bins

There are actually three kinds of bins in the Media Pool, and each appears in its own section of the Bin list. The Power Bin and Smart Bin areas of the Bin list can be shown or hidden using commands in the View menu (View > Show Smart Bins, View > Show Power Bins). Here are the differences between the different kinds of bins:

- **Bins:** Simple, manually populated bins. Drag and drop anything you like into a bin, and that’s where it lives, until you decide to move it to another bin. Bins may be hierarchically organized, so you can create a Russian dolls nest of bins if you like. Creating new bins is as easy as right-clicking within the bin list and choosing Add Bin from the contextual menu.

- **Power Bins:** Hidden by default. These are also manually populated bins, but these bins are shared among all of the projects in your current database, making them ideal for shared title generators, graphics movies and stills, sound effects library files, music files, and other media that you want to be able to quickly and easily access from any project. To create a new Power Bin, show the Power Bins area of the Bin list, then right-click within it and choose Add Bin.

- **Smart Bins:** These are procedurally populated bins, meaning that custom rules employing metadata are used to dynamically filter the contents of the Media Pool whenever you select a Smart Bin. This makes Smart Bins fast ways of organizing the contents of projects for which you (or an assistant) has taken the time to add metadata to your clips using the Metadata Editor, adding Scene, Shot, and Take information, keywords, comments and description text, and myriad other pieces of information to make it faster to find what you’re looking for when you need it. To create a new Smart Bin, show the Smart Bin area of the Bin list (if necessary), then right-click within it and choose Add Smart Bin. A dialog appears in which you can edit the name of that bin and the rules it uses to filter clips, and click Create Smart Bin.

Showing Bins in Separate Windows

If you right-click a bin in the Bin List, you can choose “Open As New Window” to open that bin into its own window. Each window is its own Media Pool, complete with its own Bin List, Power Bins and Smart Bins lists, and display controls.

This is most useful when you have two displays connected to your workstation, as you can drag these separate bins to the second display while DaVinci Resolve is in single screen mode. If you hide the Bin list, not only do you get more room for clips, but you also prevent accidentally switching bins if you really want to only view a particular bin’s contents in that window. You can as many additional Bin windows open as you care to, in addition to the main Media Pool that’s docked in the primary window interface.
Filtering Bins Using Color Tags

If you’re working on a project that has a lot of bins, you can apply color tags to identify particular bins with one of eight colors. Tagging bins is as easy as right-clicking any bin and choosing the color you want from the Color Tag submenu.

For example, you can identify the bins that have clips you’re using most frequently with a red tag. A bin’s color tag then appears as a colored background behind that bin’s name.

Once you’ve tagged one or more Media Pool bins, you can use the Color Tag Filter drop-down menu (the drop-down control to the right of the Bin List button) to filter out all but a single color of bin.
Using color tag filtering to isolate the red bins

To go back to seeing all available bins, choose Show All from the Color Tag Filter drop-down.

**Sorting the Bin List**

The Bin list (and Smart Bin list) of the Media Pool can be sorted by Bin Name, Date Created, or Date Modified, in either ascending or descending order. Simply right-click anywhere within the Bin list and choose the options you want from the Sort by submenu of the contextual menu.

You can also choose User Sort from the same contextual menu, which lets you manually drag all bins in the Bin list to be in whatever order you like. As you drag bins in this mode, a highlighted line indicates the new position that bin will occupy when dropped.

If you use User Sort in the Bin list to rearrange your bins manually, you can switch back and forth between any of the other sorting methods (Name, Date Created, Date Modified) and User Sort and your manual User Sort order will be remembered, making it easy to use whatever method of bin sorting is most useful at the time, without losing your customized bin organization.
More About Timelines and Grading

DaVinci Resolve projects contain one or more edited timelines (sometimes called a sequence in other applications) which are also organized in the Media Pool, and displayed in the Timeline Editor (referred to as “the Timeline”). Timelines contain clips, the source media of which is kept in the Media Pool, and which also appear as edit events in the Edit Index that can be shown at the right of the Timeline.

Timelines, Grades, and Versions

Within any given timeline, grades are associated with the timecode of the source clip they’re applied to. That means that as you alter the timeline, each clip’s grade moves along with it, making it extremely easy to move back and forth between editing and grading as your needs require. By default, each timeline in a project has independent sets of grades using local versions; this is true even if your timelines are duplicates. That means each clip within every timeline has a completely independent grade.

However, if you switch the clips in one or more timelines to use Remote versions, a clip’s grades are shared by every instance of that clip in all timelines with clips that also use Remote versions. If you import a new timeline that rearranges clips into a different order and switch it to using Remote versions, then grades will automatically follow the clips, so that the clips within each new timeline inherits the grades applied to those same clips in other timelines.

You can switch a timeline between using Local and Remote grades at any time. For more information on using Local versus Remote versions, see Chapter 139, “Grade Management.” You can also copy grades from one timeline to another using the ColorTrace feature. For more information about ColorTrace, see Chapter 146, “Copying and Importing Grades Using ColorTrace.”

Enabling the Use of a Master Timeline

Previous versions of DaVinci Resolve had a Master Timeline, which consisted of one long timeline containing every clip in the Media Pool, arranged by default in ascending order by timecode. While the Master Timeline was useful for a variety of tasks, architectural improvements have rendered it unnecessary, and by default the Master Timeline does not appear in new projects created by DaVinci Resolve version 10 or later.

However, if you want a Master Timeline in order to have a single timeline that always contains all clips currently in the Media Pool, there’s a way you can create one. You need to do it immediately upon creating a new project, before adding any media to the Media Pool. Once you’ve added one or more clips to the Media Pool, the option you need to do so will be disabled.

To create a new Master Timeline:

1. Create a new project, open the General Options panel of the Project Settings, and turn on the “Automatically match master timeline with media pool” checkbox. If you also want all clips to use Remote versions as you grade by default as in previous versions of DaVinci Resolve, you can turn off the “Use local version for new clips in timeline.”
The option to use a Master Timeline is in the Color section of the General Options panel of the Project Settings.

2 Click Save to close the Project Settings window.

3 Open the Edit page, and choose File > New Timeline (Command-N).

4 When the New Timeline Properties window appears, turn the Empty Timeline checkbox off, and click Create New Timeline.

Now, in addition to the new timeline, a Master Timeline appears in the Timeline list.

**TIP:** If you want to make sure that you always have a Master Timeline when you create new projects, you can alter the Project Setting preset for your user account to reflect these settings, or you can create a new Project Setting preset with these settings that you can easily switch to.

The Master Timeline consists of one long sequence of every clip in the Media Pool, arranged in ascending order by timecode. Each clip in the Master Timeline appears at its full duration, regardless of the duration of corresponding clips in an EDL-, AAF-, or XML-imported timeline. Whenever you add more clips to the Media Pool, they’re automatically added to the Master Timeline.

The Master Timeline is useful for organizing media for which no editing has yet been done, such as when grading digital dailies. The Master Timeline is also useful for identifying a range of similar clips, based on their similar ranges of timecode. For example, you could find all the talking head shots from a particular section of tape clustered together in the Master Timeline.
Using the Effects Library

All effects that you can add to your edit, including filters, transitions, titles, and generators, are found in the Effects Library, which is split into two parts. To the left is a bin list that shows a hierarchical list of all of the different Transitions, Title Effects, Generators, and Filters that are available, sorted by category. To the right is a browsing area in which you can see the contents of whichever bins are selected.

Similar to the Media Pool, the Effects Library’s bin list can be opened or closed using a button at the top left, while a menu just to the right of this button lets you sort the list into different categories.

The Toolbox

All of the video and audio transitions, titles, and generators that ship along with DaVinci Resolve appear in the Toolbox category of the Effects Library.

- **Toolbox:** Exposes all Transitions, Titles, Generators, and Effects at once.
- **Video Transitions:** Contains all of the built-in transitions that are available from DaVinci Resolve. You can drag any video transition to any edit point in the Timeline that has overlapping clip handles to add it to your edit; you have the option to drag the transition so that it ends on, is centered on, or starts on the edit point. For more information, see Chapter 49, “Using Transitions.”
- **Audio Transitions:** Contains audio transitions for creating crossfades.
- **Titles:** Titles can be edited into the Timeline like any other clip. Once edited into the Timeline, you can edit the title text and position directly in the Timeline Viewer, or you can access its controls in the Inspector for further customization.
- **Generators:** Generators can also be edited into the Timeline like any other clip. Selecting a generator and opening the Inspector lets you access its controls for further customization. You can also choose a standard duration for generators to appear with in the Editing panel of the User Preferences.
- **Effects:** Contains unique placeholder effects like Adjustment Clip, and Fusion Composition, that can be customized to apply sophisticated effects to your programs.
OpenFX

DaVinci Resolve supports the use of third-party OpenFX filters, transitions, and generators in the Edit page. Once you install these effects on your workstation, they appear in this section of the Effects Library, organized by type and group depending on the metadata within each effect.

- **OpenFX**: Exposes all Resolve FX and third-party OpenFX installed on your workstation at once.
- **Filters**: Contains the Resolve FX filters that ship with DaVinci Resolve, as well as any third-party OFX plug-ins you’ve installed on your workstation. Filters can be dragged onto video clips to apply an effect to that clip. Once applied, filters can be edited and customized by opening the OpenFX panel of the Inspector.
- **Transitions**: Contains any third-party OFX transitions you have installed on your workstation. OFX transitions can be used similarly to any other transition, but they also expose an OpenFX panel next to the Transition panel in the Inspector, where you can customize settings that are unique to that transition.
- **Generators**: Contains any third-party OFX generators you have installed on your workstation. Can be edited into the Timeline just like the native generators that ship with DaVinci Resolve, but they also expose an OpenFX panel next to the Transition panel in the Inspector, where you can customize settings that are unique to that transition.

Audio FX

On all platforms, DaVinci Resolve supports Fairlight FX, which are built-in audio plug-ins that come with DaVinci Resolve. Additionally, DaVinci Resolve supports the use of third-party VST audio plug-ins on macOS and Windows, and Audio Unit (AU) audio plug-ins on macOS. Once you install these effects on your workstation, they appear in this panel of the Effects Library. Audio plug-ins let you apply effects to audio clips or an entire track’s worth of audio to add creative qualities such as echo or reverb, or to take care of mastering issues using noise reduction, compression, or EQ.

Effects Library Favorites

You can click on the far right of any transition, title, or generator to flag that effect with a star as a favorite effect. When you do so, the favorited effects appear in a separate Favorites area at the bottom of the Effects Library Bin list.
Edit Index

Clicking the Edit Index button opens the Edit Index. By default, this shows an EDL-style list view of all the edit events in the current timeline. Whichever timeline is selected in the Timeline list displays its events here. However, the contents of the Edit Index can be filtered using commands found in the Option drop-down, described later in this section.

Each clip and transition is shown as an individual event, each of which contains multiple columns of information. If you re-edit a timeline, your changes are also reflected in this list. The Edit Index is useful for creative editors that are looking for specific effects that are used in the current timeline, or for finishing editors that need more information about a specific clip, or who might need to filter the entire edit by specific criteria in order to troubleshoot various issues.

Navigating the Timeline Using the Edit Index

Whenever you move the Timeline playhead to intersect a clip, the Edit Index updates to show only the clips on the video track the intersecting clip is on, and that clip’s event is highlighted in the Edit Index. This makes it easy to see the correspondence between a clip in the Timeline and its event, which is helpful when troubleshooting problems. There are also commands available in the Option menu to display only clips on enabled tracks, only video clips, and only audio clips.

Edit Index Columns

Each event populates several columns of information. These columns can be rearranged by dragging them to the left or right, depending on what information is most important to you.

The available columns of information are:

- #: The event number (which corresponds to the clip number shown in the Thumbnail timeline of the Color page).
- Reel: The reel name of the corresponding clip.
- Match: Flags clips that have clip conflicts, which display a question mark in this column. Once the clip conflict has been resolved, this flag disappears.
- V: Video event.
– **C:** The event type (C for cut, D for dissolve or transition).

– **Dur:** A number showing the duration of a transition in frames.

– **Source In/Source Out:** The Source In and Source Out timecode indicating the range of timecode referenced by that clip; corresponds to the timecode locations of each clip’s In and Out point relative to the source media it comes from.

– **Record In/Record Out:** Record In and Record Out timecode indicating that clip’s position in the Timeline.

– **Name:** The name of the clip.

– **Comments:** Whatever comments were present in the EDL that was imported. For example, clip names exported from the original NLE to be used as reel names in RED workflows using EDL import.

– **Source Start/Source End:** The very first and last frame of media available in the Source Media for that clip.

– **Source Duration:** The duration, in timecode, of the total source media available in that clip.

– **Codec:** The codec of the corresponding clip.

– **Source FPS:** The frame rate of the corresponding clip.

– **Resolution:** The frame size of the corresponding clip.

– **Color:** The color of flags or markers applied to that clip.

– **Notes:** Notes entered inside of markers applied to clips or the Timeline.

– **EDL Clip Name:** Shows the name of the imported EDL, if that’s available.

– **Marker Keywords:** Lists all keywords found in a particular marker.

The columns in the Edit Index can be customized to prioritize the information that’s important to you.

**Methods of customizing metadata columns in the Edit Index:**

– **To show or hide columns:** Right-click at the top of any column in the Edit Index and select an item in the contextual menu list to check or uncheck a particular column. Unchecked columns cannot be seen.

– **To rearrange column order:** Drag any column header to the left or right to rearrange the column order.

– **To resize any column:** Drag the border between any two columns to the right or left to narrow or widen that column.

You can also customize column layouts in the Edit Index. Once you’ve customized a column layout that works for your particular purpose, you can save it for future recall.

**Methods of saving and using custom column layout:**

– **To create a column layout:** Show, hide, resize, and rearrange the columns you need for a particular task, then right-click any column header in the Media Pool and choose Create Column Layout. Enter a name in the Create Column Layout dialog, and click OK.

– **To recall a column layout:** Right-click any column header in the Media Pool and choose the name of the column layout you want to use. All custom column layouts are at the top of the list.

– **To delete a column layout:** Right-click any column header in the Media Pool and choose the name of the column layout you want to delete from the Delete Column Layout submenu.
Filtering the Edit Index

You can use options found in the Edit Index’s option menu to filter specific things that you want to check out, whether to go through all of the marked clips to see if there are any notes you need to address, or to isolate all offline clips, or to go through edits to see if there’s anything you need to fix. You can filter the Edit Index in the following ways:

– **Show All:** Shows all entries in the list. Choose this option after using any of the other options to go back to seeing the entire timeline.

– **Show Active Track Items:** Filters out all clips that appear on tracks above or below tracks identified with a destination control. For example, if you have three video tracks and the destination control is on track V2, then all clips on tracks V1 and V3 will be hidden from the Edit Index.

– **Show Video Track Items:** Filters out all audio clips so only video clips appear in the list.

– **Show Audio Track Items:** Filters out all video clips so only audio clips appear in the list.

– **Show Flags:** Isolates clips with flags in the list. A submenu lets you choose to show all clips with flags or only clips with a particular color of flag.

– **Show Markers:** Isolates all clips with markers in the list. A submenu lets you choose to show all clips with markers or only clips with a particular color of marker.

– **Show Clip Colors:** Isolates all clips that have been labelled with clip colors in the list. A submenu lets you choose to show all clips that are labelled using any clip color or only clips labelled with a particular color.

– **Show Through Edits:** Filters only clips that have through edits, or cuts where continuous timecode appears from the outgoing to the incoming half of the edit, that you may or may not want to remove, depending on why they’re there.

– **Show Offline Clips:** Isolates all offline clips (clips that have become unlinked from the corresponding source media on disk) in the Timeline, so you can quickly navigate to each one and troubleshoot the issue.

– **Show Clip Conflicts:** Filters all clips with clip conflict warning badges (indicating there is reel, name, and timecode metadata that overlap that of another clip) in the Timeline, so you can quickly navigate to each one and check whether they’re using the correct clip.

– **Show Clips With Speed Effects:** Filters all clips with linear or variable Speed Effects in the Timeline.

– **Show Clips With Composite Effects:** Filters all clips with Composite mode or Opacity settings other than the default (Normal, 100).

– **Show Clips With Transform Effects:** Filters all clips with altered Transform settings.

– **Show Clips With Filters:** Filters all clips with Resolve FX or OFX filters applied to them.

– **Show Stills and Freeze Frames:** Filters all clips that are stills or that have freeze frame speed effects applied to them.

– **Show Compound Clips and Nested Timelines:** Filters all compound clips and nested timelines in the Timeline.

– **Show VFX Connect Clips:** Filters all Fusion Connect Clips.

Exporting the Edit Index

If you’ve filtered a series of edits in the Edit Index that you’d like to share with someone else, this is easy to do. For example, you might filter the Edit Index to show a list of all the offline clips in the current timeline, and then export a list as either a .csv or .txt file to give to your assistant editor so they can chase down the necessary media. Both types of files are widely compatible with spreadsheet and database software in the event you want to import the data into another application.
To export the Edit Index:

1. Right-click the currently open timeline in the Media Pool, and choose Timelines > Export > Edit Index from the contextual menu.

2. Use the Export Edit Index window to choose a location to save the exported file, and choose a format from the drop-down menu at the bottom. You can export either a Comma Separated Values (.csv) file, or a Tab Delimited Values (.txt) file.

3. Click Save.

Source and Timeline Viewers

By default, the Edit page presents a traditional source/record style editing experience. The Source Viewer lets you view individual clips from the Media Pool to prepare them for editing. Meanwhile, the Timeline Viewer lets you play through your program, showing you the frame at the position of the playhead in the Timeline.

You can select either viewer by clicking with the pointer, or by pressing Q (Source/Timeline Viewer), and the name of the viewer that currently has focus appears in orange.

How Each Clip’s Grade Looks in Each Viewer

Because of DaVinci Resolve’s deep color and effects tools, the state of the image you see in each viewer of the Edit page depends on a number of things.

The Source Viewer

The Source Viewer shows each clip as it looks at the source. If you have Resolve Color Management (RCM) turned on or source LUTs applied, then the Source Viewer will show your clips as they’re being processed by RCM and/or the source LUTs, since those are source-level color operations. However, in the absence of RCM and source LUTs, the image in the Source Viewer looks exactly the same as it does on disk. If you have log-encoded media that looks flat and low-contrast, then that’s how it’s going to look in the Source Viewer.

The Timeline Viewer

The Timeline Viewer follows all of the same rules as the Source Viewer, with the addition that the Timeline Viewer also shows you how each clip in the Timeline looks with Fusion page and/or Color page operations applied, since the Timeline Viewer is actually showing you the output of the Color page, so you can see every clip of your program in context of how the image is being affected by the DaVinci Resolve image processing pipeline.
NOTE: The Color Viewer Lookup Table options in the Color Management panel of the Project Settings only affect the GUI Viewer in the Color page. They do not affect the viewers in the Edit page.

Turning Grades and/or Fusion Effects Off in the Timeline Viewer

The Bypass Color Grades and Fusion Effects button/drop-down from the Color page is also available on the Edit page either via the View > Bypass Color and Fusion drop-down, or via a toggle button/drop-down menu in the Timeline Viewer. If you choose Toggle Bypass or click the Viewer control, you’ll turn off whatever is checked in the optional menu, which lets you choose whether or not you want to bypass both Color and Fusion, or just one or the other.

![Menu commands for bypassing Color and Fusion]

Turning off color grades and Fusion effects is an easy way to improve playback performance on low power systems when you just need to make a quick set of edits, and it’s also a convenient way to quickly evaluate the original source media.

Source and Timeline Viewers vs. Single Viewer Mode

If you want to change the Edit page layout to hide the Source Viewer, you can choose Workspace > Single Viewer Mode to instead use just a single viewer to contextually display either a selected Source Clip or the current frame of the Timeline.

![Single Viewer mode turned on]

In Single Viewer mode, whatever you select in the Media Pool or Timeline determines which controls appear in the Viewer, which lets you do nearly everything you can do with two simultaneously open viewers.
**Viewer Controls**

Both viewers share the following onscreen controls:

- **Zoom drop-down menu:** Choosing Fit fits the currently visible frame to the available size of the viewer. Choosing a percentage zooms the visible frame to that size. You can also use the scroll wheel functionality of your mouse, trackpad, or tablet to zoom in and out of the viewer.

- **Duration field:** At the top left-hand side of the Source Viewer, this displays the total duration of the clip, or the duration from the In to the Out point, if these have been placed. In the Timeline tab, this displays the total duration of the currently selected timeline.

- **GPU Status Display:** Every viewer in DaVinci Resolve exposes a GPU status indicator and a frame-per-second (FPS) meter, which appears in the viewer’s title bar, which shows you your workstation’s performance whenever playback is initiated. Since DaVinci Resolve uses one or more GPUs (graphics processing units) to handle all image processing and effects, the GPU status display shows you how much processing power is being used by whichever clip is playing.

- **Clip Name:** The clip name is displayed at the center of the Source Viewer title bar.

  - The Source Viewer displays a drop-down at the top of the Source Viewer, next to the name of the currently open clip, which lets you open a menu containing a list of the last 10 clips you opened in the Source Viewer. This list is first in, first out, with the most recently opened clips appearing at the top.

  - The Timeline Viewer displays the timeline name and is also a drop-down menu that lets you switch among other timelines in the current project. The clip/timeline name is highlighted orange when either the Source or Timeline Viewer has focus.

- **Bypass Color Grades and Fusion Effects:** The Bypass Color Grades and Fusion Effects button/drop-down from the Color page is also available on the Edit page either via the View > Bypass Color and Fusion drop-down, or via a toggle button/drop-down menu in the Timeline Viewer. Turning off color grades and Fusion effects is an easy way to improve playback performance on low power systems when you just need to make a quick set of edits, and it’s also a convenient way to quickly evaluate the original source media.

- **Source/Timeline Timecode/Frame/Keykode Display:** At the top right-hand side of the Source Viewer, this field shows the timecode of the current frame at the position of the playhead in the Source Viewer’s jog bar, and can be switched between source timecode, source frame, and keykode by right-clicking and choosing from the contextual menu. In the Timeline Viewer, this field shows the record timecode of the current frame at the position of the playhead in the Timeline, and can be switched between source and record timecode, source and record frames, and keykode by right-clicking and choosing from the contextual menu.

- **Source Viewer Option menu:** Contains the following commands:

  - **Gang Viewers:** With Gang Viewers enabled, the movement of the Source and Timeline Viewer playheads is locked together, so that they move in unison. This is useful when you’re matching the timing of part of a clip in the Source Viewer to match an event in the Timeline.

  - **Live Media Preview:** Enabled by default, makes it possible for thumbnails that you’re skimming in the Media Pool to show the skimmed frame in the Viewer. When skimming with Live Media Preview enabled, the playhead that appears in the thumbnail is locked to the playhead displayed in the Viewer’s jog bar.

  - **Show All Video Frames:** When available processing power is insufficient to play the clip or clips at the position of the playhead due to the grade, transforms, or effects that are applied at that moment in the Timeline, you have the ability to choose exactly how performance in DaVinci Resolve degrades. When off, DaVinci Resolve prioritizes audio playback at the expense of dropping video frames when processing power is tight, resulting in a more conventional playback experience. When on, audio quality is compromised while every frame of video plays in slower-than-real time to maintain playback.
– **Show Zoomed Audio Waveform:** When enabled, shows an audio waveform overlay at the bottom of the Source Viewer with a zoomed in section of the audio surrounding the current position of the playhead.

– **Show Full Clip Audio Waveform:** When enabled, shows an audio waveform overlay at the bottom of the Source Viewer that displays the audio over the entire duration of the clip.

– **Show Marker Overlays:** Enabled by default, markers that intercept the playhead when playback is paused appear superimposed in the Viewer.

– **Markers submenu:** When one or more markers are applied to the clip in the Source Viewer, they appear in this list in chronological order, listed by Name and Note. Choosing a marker from this menu jumps the playhead to that marker in the Source Viewer.

– **Timeline Viewer Option menu:** Contains the following commands:

  – **Gang Viewers:** With Gang Viewers enabled, the movement of the Source and Timeline Viewer playheads is locked together, so that they move in unison. This is useful when you’re matching the timing of part of a clip in the Source Viewer to match an event in the Timeline.

  – **Show All Video Frames:** When available processing power is insufficient to play the clip or clips at the position of the playhead due to the grade, transforms, or effects that are applied at that moment in the Timeline, you have the ability to choose exactly how performance in DaVinci Resolve degrades. When off, DaVinci Resolve prioritizes audio playback at the expense of dropping video frames when processing power is tight, resulting in a more conventional playback experience. When on, audio quality is compromised while every frame of video plays in slower-than-real time to maintain playback.

  – **Show Marker Overlays:** Enabled by default, markers that intercept the playhead when playback is paused appear superimposed in the Viewer.

  – **Show Timecode Overlays:** Toggles a window displaying the source timecodes of all video and audio clips under the playhead.

  – **Markers submenu:** When one or more markers are applied to a Timeline, they appear in this list in chronological order, listed by Name and Note. Choosing a marker from this menu jumps the playhead to that marker in the Timeline.

– **Source Viewer Mode drop-down (Source Viewer only):** This drop-down menu lets you set the Source Viewer to display different views of the clips you’re working on, depending on what you need to do.

  – **Source:** Shows the video of the currently open clip in the Source Viewer.

  – **Offline Reference Movie button:** If you’ve assigned an offline reference movie to the currently selected timeline, clicking the Offline Mode button lets you display the offline movie so you can compare it with the currently open timeline. In this mode, Source and Timeline playback are synced; an Offset field replaces the duration field, letting you re-sync the offline reference movie, if necessary.

  – **Audio Track:** Shows the audio waveforms corresponding to all channels of the currently open clip in the Source Viewer. The top of this audio-only view shows the waveform for the entire duration of the clip, while the main region of the viewer shows a zoomed in section of the audio waveform. The level of zoom displayed is controlled by the zoom drop-down at the upper left-hand corner of the Source Viewer.

  – **Multicam:** Shows you the multi-angle Multicam Viewer that you can use to switch among different angles of video and audio while multicam editing a clip in the Timeline. For more information on multicam editing, see Chapter 42, “Multicam Editing.”

  – **Annotations:** Allows you to draw directly onto the current frame to highlight areas for further attention.
– **Transform Mode drop-down (Timeline Viewer Only):** This functions as both a toggle switch and a drop-down menu. Clicking the button control to the left enables or disables onscreen controls that you can use to transform the clip right in the viewer. Clicking the drop-down control to the right lets you switch between two modes of transforms:
  - **Transform:** Exposes controls for Pan (X) and Tilt (Y), Scale X and Y, and Rotation.
  - **Crop:** Exposes controls to crop from the top, bottom, left, and right.
  - **Dynamic Zoom:** Shows controls to do quick pan and scan effects on the selected clip.
  - **OpenFX Overlay:** Exposes the onscreen controls of an applied OpenFX filter.
  - **Fusion Overlay:** Exposes the onscreen controls of an applied Fusion FX or Title filter.
  - **Annotations:** Allows you to draw directly onto the current frame to highlight areas for further attention.
  - **Smart Reframe:** Exposes the onscreen controls of the Smart Reframe.

– **Jog control:** Clicking the Jog control and dragging left and right lets you move slowly through a clip or the Timeline a frame at a time.

– **Transport controls:** These controls include, from left to right, Jump to First Frame, Play Reverse, Stop, Play Forward, Jump to Last Frame.

– **Loop Playback:** Enables or disables looped playback. Looping is also controllable via the Playback > Loop/Unloop command (Command-/). When enabled, each playback command loops back to the beginning when the end of that command’s range is reached. In and Out points in the Source or Timeline Viewers do not trigger looping. For example, when enabled, the Play command will play through the entire clip or timeline, and then loop back to the beginning when the end is reached and start playing automatically. The Play Around command, on the other hand, will start at the beginning of pre-roll, play through the post-roll, and then immediately loop back around to the beginning of pre-roll, continuing playback in this manner until you stop it.

– **Match Frame:** In the Source Viewer, Match Frame attempts to move the playhead in the Timeline to match the current frame of the clip in the Source Viewer. In the Record Viewer, Match Frame opens the Media Pool clip corresponding to the clip at the current position of the playhead into the Source Viewer, setting In and Out points and the playhead position to match those of the clip in the Timeline.

– **In/Out buttons:** Places In and Out points with which to define a range of the clip, or of the Timeline, in preparation for making different kinds of edits.

– **Jog bar:** In the Source Viewer, drag within the jog bar to reposition the Source playhead, scrubbing through the clip. In the Timeline tab, drag to reposition the playhead throughout the entire program.

---

**Transport Controls and Important Playback Controls**

While the operation of the main transport controls is probably obvious, there are additional playback controls of interest to the editor that may not be so readily found.

For more information about transport controls, see Chapter 36, “Preparing Clips for Editing and Viewer Playback.”
Simultaneous Audio Waveform Display in the Source Viewer

When the Source Viewer is set to Source, two options in the Option menu let you see a superimposed audio waveform running along the bottom of the viewer, over the video of the currently selected clip.

- **Show Zoomed Audio Waveform:** Shows a zoomed-in section of audio that scrolls as you play the clip. Useful for seeing dialog and music cues as you play through a clip.

- **Show Full Clip Audio Waveform:** Shows the audio waveform for the entire source media of that clip. The section of audio from the In to Out points you’ve set in the Source Viewer are highlighted. Useful for using the audio waveform to navigate throughout that clip using the waveform as a reference.

![The Source Viewer with “Show Current Frame Audio Waveform” enabled](image)

Cinema Viewer Mode

You can also put either the Source or Timeline Viewers into Cinema Viewer mode by choosing Workspace > Viewer Mode > Cinema Viewer (P), causing whichever viewer is currently selected to fill the entire screen, which is good for doing a test viewing of your edit without the distractions of the DaVinci Resolve Edit Page UI. This command toggles Cinema Viewer mode on and off.

Viewer Indicators

Certain frames trigger visible indicators in either the Source or Timeline viewers. For example, if the playhead is at the very first or last frame of media available to a particular clip, indicators appear in the lower-left or right corner of the frame to let you know there’s no more media in that direction.

![The first and last frame clip indicators](image)

If the playhead in the Timeline is on the first frame of black immediately after the last video clip in the Timeline, an end of sequence indicator appears in the Timeline Viewer to let you know that you’re viewing the last frame of the current sequence of clips, even though the playhead is actually on a frame of black. This makes it easy to see what you’re doing while you’re first assembling clips together.
Other Viewer Options

There are additional overlays and options you can use to customize how the viewer appears, available in the View menu.

- **Safe Area**: Choosing View > Safe Area > On lets you turn on Safe Area overlays showing you Title Safe, Action Safe, and other available overlays. If you want to choose the aspect ratio with which these overlays are represented, you can do so from the View > Select Aspect Ratio submenu.

- **Show Gray Backgrounds in Viewers**: Choosing View > Show Gray Backgrounds in Viewers sets the empty area of the viewer (if there is any) to a lighter gray, making it easier to see which parts of the viewer are black because of blanking, and which parts are simply empty because of the way the image is zoomed or panned.

Fast Review in the Timeline Viewer

Fast Review plays back your timeline at variable fast forward speeds where the speed of playback is dependent on the length of each clip on the Timeline. Longer clips play back at faster speeds than shorter ones. This feature is designed to allow you to quickly scan through a large amount of material on a timeline.

To use the Fast Review feature on your Edit page Timeline, select Playback > Fast Review. Pressing K or the spacebar will return you to the normal JKL playback mode. If you use this feature often you can bind Fast Review to a specific key in the Keyboard Customization window.

**NOTE**: Fast Review does not work for clips in the Source Viewer, only for timelines in the Timeline Viewer.

Opening Clips in the Source Viewer

There are two methods of opening clips into the Source Viewer. Which is enabled depends on the “Live Media Preview” setting found in the Viewer options menu (the three-dots menu found at the upper right-hand corner of the Viewer).

When Live Media Preview is enabled (by default), skimming a thumbnail in the Media Pool also shows the skimmed frame in the Source Viewer, effectively opening each clip you skim in the
Media Pool into the Source Viewer. As you skim, the playhead that appears in the thumbnail is locked to the playhead that’s displayed in the Viewer’s jog bar.

When Live Media Preview is disabled, you must either double-click a clip in the Media Pool to open it into the Source Viewer, or you can select a clip in the Media Pool and press the Return key to open it into the Source Viewer.

Which method is best is purely a matter of preference.

### Timeline Viewer Edit Overlays

Dragging a clip from the Media Pool or Source Viewer onto the Timeline Viewer also exposes edit overlays that let you choose what kind of edit you want to make by choosing which overlay to drop the clip onto.

The overlay that appears when you drag a clip onto the Timeline Viewer lets you choose from a variety of edits.

This overlay exposes every type of edit that’s available in DaVinci Resolve, including the Insert, Overwrite, Replace, Fit to Fill, Place On Top, Ripple Overwrite, and Append at End edits, all of which are also available from the Edit menu. It’s a useful method of making three-point edits if you like drag and drop editing, but it also provides a nice reminder of what types of edits are available, given all the different options that are available.

By default, the larger empty area to the left of these overlays defaults to the highlighted Overwrite overlay, while all the smaller buttons let you perform each of the other edit types that are available.

However, the “Timeline overlay retains the last performed action” checkbox in the Editing panel of the User Preferences can be turned on if you want DaVinci Resolve to always remember the last edit type you used, and highlight it on this overlay whenever you drag another clip over the Timeline Viewer to let you know that the last edit you performed is the new default edit if you drop clips to the left of the overlay. For example, with this option enabled, if you perform a place on top edit, then the next time you drop a clip into the empty area to the left of the overlays, the result will be another place on top edit. This option is off by default.

### Copy and Paste Timecode in Viewer Timecode Fields

You can right-click on most Viewer timecode fields in the Media, Edit, and Color pages to choose Copy and Paste commands from a contextual menu for copying and pasting timecode values. You can also click in the timecode fields and use the normal Copy (Command-C), and Paste (Command-V) keyboard commands. This works even between pages. The timecode value you’re pasting must be valid timecode, for example you can’t paste 0 hour timecode onto a 1 hour timeline.
Right-clicking on a timecode field to use the Copy Timecode command

Metadata Editor

Both the Media and Edit pages have a Metadata Editor. In the Edit page, the Metadata Editor opens in the same place as the Inspector, to the right of the Source and Timeline Viewers. When you select a clip in the Media Pool or Timeline, its metadata is displayed within the Metadata Editor, and the title bar indicates whether you’re evaluating a clip in the Timeline or Media Pool. If you select multiple clips, only the last clip’s information appears. The Metadata Editor’s header contains uneditable information about the selected clip, including the file name, directory, duration, frame rate, resolution, and codec.

Because there are so very many metadata fields available, two drop-down menus at the top let you change which set of metadata is displayed in the Metadata Editor.

– **Metadata Presets (to the left):** If you’ve used the Metadata panel of the User Preferences to create your own custom sets of metadata, you can use this drop-down to choose which one to expose. Surprisingly enough, this is set to “Default” by default.

– **Metadata Groups (to the right):** This drop-down menu lets you switch among the various groups of metadata that are available, grouped for specific tasks or workflows.

The heart of the Metadata Editor is a series of editable fields underneath the header that let you review and edit the different metadata criteria that are available. For more information on editing clip metadata, and on creating custom metadata presets, see Chapter 18, “Using Clip Metadata.”
Inspector

The Inspector can be opened to let you customize compositing, transform, and cropping parameters for clips, as well as clip-specific retime and scaling options. Furthermore, the Inspector lets you edit the parameters of transitions, titles, and generators used in the Timeline, in order to customize their effect.

When the Inspector is open, the Source and Timeline viewers move to the left, to sit alongside the Inspector showing the selected clip’s parameters. However, if your computer display’s resolution is not high enough, opening the Inspector may result in the Source Viewer being hidden.

Methods of showing parameters in the Inspector:

– To open a video or audio clip’s transform settings when the Inspector is closed: Select that clip, and then click the Inspector button at the far right of the Edit page toolbar.

– If the Inspector is already open: You need only select a clip or effect to reveal its controls in the Inspector.

– If the Inspector is closed: Double-clicking any transition will automatically open it.

The Inspector shows different buttons at the top that let you switch among different pages of parameters. For example, when you select a clip with both audio and video components, the Inspector shows Video and Audio buttons at the top that let you switch among each set of controls.

Timeline

The Timeline shows whichever timeline you’ve double-clicked in the Timelines browser. It’s where you either edit programs together from scratch, or import sequences from other applications. For imported programs, the Timeline provides a visual representation of the edited program that’s helpful for verifying that the project was imported correctly, checking the media corresponding to each clip in the program, and performing whatever editorial tasks are necessary to prepare a project for grading (such as replacing or adding clips, superimposing composites, and modifying composite modes or transitions).
The Timeline Ruler shows the program’s timecode, and the playhead indicates the current frame of the current clip. Whichever clip intersects the playhead is the one that you’ll be working on in the Color page. Dragging within the Timeline Ruler moves the playhead. When you add markers to the timeline, these markers appear within the Timeline Ruler, as well.

The playhead automatically syncs with the Timeline Viewer’s jog bar playhead, the playheads in the Mini-Timeline and Thumbnail timeline of the Color page, Cut page, and the playhead on the Deliver page. Furthermore, the Edit Index event that corresponds to the clip intersecting the playhead is automatically highlighted.

Shows the current timecode value corresponding to the position of the playhead.

DaVinci Resolve supports multiple video tracks. At the left of each track is a header area that contains a number of controls.

The Track Header contains different controls for selecting, locking/unlocking, and enabling/disabling tracks. Each track header also lists how many clips appear on that track. The Track Header contains the following five controls, from left to right:

Each track can be color-coded with one of 16 different colors. These color codes correspond to the Edit page Mixer, and to the Fairlight page Mixer and Audio Meters. You can choose a new color for any track by right-clicking the track header and choosing from the Change Track Color submenu.

These controls are highlighted orange when that track is selected for editing, dark gray when that track is not selected, and flat gray if that track is disabled for editing. The Destination buttons dictate into which tracks audio and video media in the Source Viewer will be placed when an edit is executed. Ordinarily, there is one video destination control (V1) and one audio destination control (A1). If you add additional tracks, you can see that each destination control is numbered according to its track position. The bottom track is “V1,” and subsequently numbered tracks appear higher in the Timeline. Click any track’s number to select that track for different editing functions; the selected track is highlighted black.
Track Name: Each track has a name that defaults to the type of track and the track number, such as Video 1, Audio 1. However, you can click any track’s name and edit it to be whatever you like. For example, you can rename each audio track with the type of audio you’re editing onto it, such as Production, Ambience, SFX, or Music. These track names are also used to identify each track’s channel in the Edit page Mixer and in the Fairlight page Mixer.

Enable Track/Mute button: A slash indicates when a track is disabled. This control lets you turn tracks on and off. Clips on tracks that are turned off aren’t visible in the viewer, don’t show up in the Color page, and aren’t available for rendering or output. For Audio tracks this is the Mute button.

Lock Track button: Light gray when turned on, dark gray when turned off. When a track is locked, clips can’t be replaced, moved, or otherwise edited, although clips on locked tracks can be graded.

Auto Select button: On by default. Light gray when that track is selected, dark gray when that track is not selected. When this control is on, clips on that track are automatically included in operations that affect all clips that intersect the position of the playhead, or that intersect a region defined by the Timeline In and Out points. When this control is off, clips on that track are ignored by those same operations. Furthermore, rippling is suspended on tracks with Auto Select turned off for operations that would otherwise ripple the Timeline. Note, manual selections made in the Timeline that highlight specific clips take precedence over the Auto Select controls, so if Auto Select is turned off on track 1, but you’ve selected a clip on track 1, the selected clip will still be affected by whatever operation you’re about to perform.

Audio Channel Type indicator: Audio tracks also show which channel configuration that track uses, listing the number of channels for mono, stereo, 5.1, 7.1, and adaptive.

Number of clips: The number of clips on that particular track of the Timeline is listed, but only if the track is tall enough to have room for them.

Vertical and horizontal scroll bars: If your project is longer than the current width of the Timeline, or the number of video tracks is taller than the current height of the Timeline, these scroll bars let you drag to navigate around your program.

Individual Timeline track resizing: Any track in the Timeline can be individually resized by dragging its top divider in the Track Header area.

Timeline Options

Specific elements and behaviors within the Timeline can be customized in various ways.

Selection Follows Playhead

As of DaVinci Resolve 17, the Clip selection no longer automatically moves along with the playhead. Instead, a new set of commands lets you create and move a selection by holding down the Command key and pressing the Up, Down, Left, and Right Arrow keys. This allows you to select clips above and below the current track and to the left and right, independently of the playhead.
You can return the Clip Selection mode back to its previous behavior of automatically selecting the top clip it’s intersecting by choosing the option Timeline > Selection Follows Playhead.

**Show Playhead Shadow**

Ordinarily, the playhead is shown in the Timeline as a single line that indicates the beginning of the frame that you’re viewing in the Timeline Viewer. However, you can choose View > Show Playhead Shadow to display an orange-ish background surrounding the playhead.

This shadow can make it easier to see the playhead’s position, and it can also serve as a measuring tool for projects where you have an interest in visualizing a specific offset, in frames, both before and after the current position of the playhead. This offset can be adjusted by changing the Pre- and Post-Playhead Shadow Length parameters in the Editing panel of the User Preferences, which let you specify the number of frames to shadow both before and after the playhead. The default length of the playhead shadow is 5 frames.

**TIP:** You can set the “Pre-playhead shadow length” to 0, and the “Post-playhead shadow length” to 1 if you want to display a “Media Composer-style” playhead that shows the duration of the current frame.

**Enabling and Disabling Audio Scrubbing**

Audio scrubbing is enabled by default, meaning that you’ll hear audio when dragging the playhead with the mouse back and forth. While this can be useful when you’re searching for audio cues, it can also be distracting if you’re just focused on the picture.

**To enable or disable audio scrubbing:**

– Choose Timeline > Audio Scrubbing (Shift-S)

**Playback Post-Roll**

Enables the playhead to continue playing past the last clip in the Timeline for a duration equal to the “Post-roll time” Project Setting in the Editing panel. This is good for editors that want to experience a few moments of playback after cutting or fading to black after the last frame of audio and video in the Timeline.
To enable or disable playback post-roll:
- Choose Timeline > Playback post-roll

**Switching Among Multiple Timelines**

Timelines can be organized like any other clip in the Media Pool. To open or switch among timelines, use the following procedures.

**To switch timelines, do one of the following:**
- Double-click a timeline in the Media Pool on any page.
- Turn on Stacked Timelines in the Timeline View Options menu of the Edit page toolbar, so that all timelines you open appear as tabs. Clicking different tabs switches to that timeline.
- In the Edit page Timeline Viewer, choose a timeline from the Timelines drop-down menu at the top of the viewer.
- In the Color page, choose a timeline from the Timelines drop-down menu at the top of the Viewer.
- In the Fairlight page, choose a timeline from the Timelines drop-down menu to the left of the transport controls.

**Toolbar**

At the center of the toolbar that sits above the Timeline, several buttons let you choose different tools and options for performing various editing functions.

- **Timeline View Options:** The controls let you customize the look of the clips on the tracks (Filmstrip, Thumbnail, or Minimized), audio waveform displays, stacked timelines, subtitles, and the adjustable height of the video and audio tracks.

- **Selection Mode:** The default mode in which you can move and resize clips in the Timeline, roll edits, and do other basic editing tasks. In this mode, making specific selections in the Timeline and using the nudge commands of Comma and Period resizes, moves, or rolls the selection, as does absolute or relative timecode entry.
– **Trim Edit Mode:** In this mode, the Trim tool lets you make slip, slide, ripple, and roll edits by dragging different parts of clips in the Timeline, by making specific selections and using the “nudge” keyboard shortcuts of Comma and Period to move the selection left or right, or by making specific selections and using timecode entry to make relative or absolute adjustments.

– **Dynamic Trim Mode:** This mode works in conjunction with either the Selection or Edit modes. With Dynamic Trim mode enabled, you can either resize and move clips (in Selection mode), or ripple, slip, or slide them (in Trim mode) using the JKL keyboard shortcuts that play forward and backward through the Timeline. While enabled, the spacebar triggers the Play Around Current Selection command. The Toolbar button for this mode also changes to show you whether you’re in slip or slide mode for nudging, timecode-entry adjustment, or dynamic trim (set by pressing the S key).

– **Blade Edit Mode:** Lets you add cuts to clips at the playhead in the Timeline by clicking.

– **Insert Clip:** Performs an insert edit to the Timeline with whatever clip is in the Source Viewer.

– **Overwrite Clip:** Performs an overwrite edit to the Timeline with whatever clip is in the Source Viewer.

– **Replace Clip:** Performs a replace edit to the Timeline with whatever clip is in the Source Viewer.

– **Snapping:** Enables or disables clip snapping. When turned on, clip In and Out points, markers, and the playhead all snap to one another for reference while you’re editing.

– **Linked Selection:** Enables or disables audio/video linking. When turned on, clicking a video clip in the Timeline automatically selects the corresponding audio clip if they’re linked together. When turned off, clicking a video clip won’t select its audio. Clip linking can be toggled while you work by pressing the Option key while clicking to make selections in the Timeline.

– **Position Lock:** Prevents clips from being moved to the left or right, and it prevents all ripple operations. Essentially ensures all the Timeline elements stay in sync and can’t be adjusted accidentally.

– **Flag Clip/Flag Colors drop-down menu:** Flags identify clips, and indicate all clips that correspond to the same item of media in the Media Pool. Clips can have multiple flags. Clicking the Flag button automatically adds a flag to whichever clip is currently selected in the Timeline. A drop-down menu to the right lets you choose differently colored flags, and clear all flags from the currently selected clip.

– **Add Marker/Marker Colors drop-down menu:** Markers identify specific frames of individual clips. Clicking the Add Marker button adds a marker of the currently displayed color to the clip at the position of the playhead in the Timeline. A drop-down menu to the right lets you choose differently colored markers, and clear all markers from the currently selected clip.

– **Full Extent Zoom:** Dynamically adjusts the zoom level to encompass the whole Timeline as you add or remove clips.

– **Detail Zoom:** Zooms the Timeline in on the Playhead to the frame level.

– **Custom Zoom:** Zooms the Timeline to the level selected by the Zoom slider to its immediate right.

– **Zoom slider:** Lets you zoom into or out of the clips in the Timeline. Use the scroll wheel of your mouse to horizontally zoom into and out of the Timeline. Scrolling up zooms in, while scrolling down zooms out. You can also use Command-Plus to zoom in, and Command-Minus to zoom out, and Shift-Z to fit every clip in your program into the available width of the Timeline.

These functions are described in greater detail in the following sections of this chapter.
Toolbar Audio Monitoring Controls

At the far right of the toolbar, a set of three monitoring controls lets you quickly control the output volume of your mix. An audio Enable/Disable button lets you turn audio playback on and off, while a slider lets you change the volume, and a DIM button lets you temporarily duck the monitored volume being output in order to have a quick chat with your client about sports or the state of the world while keeping half an ear on the mix.

When there are multiple audio Mains defined for a project, an additional drop-down dialog appears with the audio monitoring controls in the toolbar that lets you choose which Main you’re listening to.

The Mixer and Meters

The Audio Mixer provides a set of graphical controls you can use to set track levels, pan stereo audio, and mute and solo tracks, all while you continue to edit.

To open the Audio Mixer:

- Click the Mixer button on the Interface toolbar.

The Audio Mixer exposes a set of channel strips with controls that correspond to the tracks in the Timeline, and each channel strip displays a number of audio meters equal to the number of channels within that track. By default, a Main 1 channel strip appears all the way to the right that lets you adjust the overall level of the mix. However, if you add subs and mains on the Fairlight page, those will appear at the right of the mixer as well.
For more information about the use of the Mixer in the Edit page, see Chapter 45, “Working With Audio in the Edit Page.” For more information about using the Mixer in the Fairlight page, see Chapter 174, “Mixing in the Fairlight Page.”

Displaying Audio Meters

If you just want to see your program’s levels, you can also switch to display the “Control Room” audio meters instead of the Mixer. How many audio meters appear depends on the current speaker configuration in the Video and Audio I/O panel of the System Preferences.

To show the Audio Meters:
– Click the Mixer button on the Interface toolbar to display the audio panel, and then choose Meters from the option menu at the upper right-hand corner.

Using Video Scopes

DaVinci Resolve has a set of four real-time video scopes that you can use to monitor the internal data levels of clips in your project as you work. Each scope provides an unambiguous graphical analysis of the various characteristics of the video signal, showing you the relative strength and range of individual color components including luma, chroma, saturation, hue, and the red, green, and blue channels that, together, comprise the color and contrast of the images in your program.

To open video scopes from the Media, Cut, Edit, Color, or Deliver pages, do one of the following:
– Choose Workspace > Video Scopes > On/Off (Command-Shift-W) to open video scopes into a floating window.
– Choose Workspace > Dual Screen > On to open video scopes as part of a dual screen layout.

The video scopes aren’t just available in the Color page. They’re also available in the Media, Cut, Edit, and Deliver pages for whenever you need to evaluate the video signal more objectively, such as when you’re setting up to capture from tape or scan from film, or when you’re setting up for output.

For more information on using the video scopes, see Chapter 124, “Using the Color Page.”
Floating Timecode Window

A Timecode Window is available from the Workspace menu on every page except Fusion. Choosing this option displays a floating timecode window that shows the timecode of the Viewer or Timeline that currently has focus. This window is resizable so you can make the timecode larger or smaller.

A new floating timecode window is available

Dual Monitor Layout

The Edit page has a dual monitor layout that provides maximum space for the Timeline and Viewers on the primary monitor, and an enlarged Media Pool, simultaneously displayed Timelines browser, Edit Index, Effects Library, and Metadata Editor on the secondary monitor.

To enter dual screen mode:
- Choose Workspace > Dual Screen > On.
To switch which UI elements appear on which monitors:
Choose Workspace > Primary Display > (Monitor Name), which reverses the contents of both monitors in dual screen mode.

Customizing the Edit Page

The default layout is quite efficient for a number of tasks on most displays. You can always return to the default layout by choosing Workspace > Reset UI Layout. However, the Edit page can be customized to create more room for specific areas of the interface to accommodate different tasks.

To resize any area of the Edit page:
– Drag the vertical or horizontal border between any two panels to enlarge one and shrink the other.

To expand the width of the Timeline:
– Click the Media Pool/Effects Library/Edit Index height button to reduce the area used by the Media Pool, Effects Library, and/or Edit Index to shrink to half height. At this size, the Media Pool/Effects Library/Edit Index are restricted to the top of the UI (you can only show one at a time), and the Timeline takes up the full width of your display.
– Hiding the Edit Index and the Effects Library causes the Timeline to expand to the full width of your screen.

To resize the height of individual video or audio tracks:
– Move the pointer to the top border of any video track header, or the bottom border of any audio track header, and when it becomes a resize cursor, drag that border up or down to resize that track. Each track can have an independent size when you do this.

To enable a full-screen timeline in Dual Screen mode:
– Choose Workspace > Dual Screen > Full Screen Timeline, which causes the Timeline to fully occupy the primary display, while the Browser, Viewers, Audio Mixer, Edit Index, and Effects Library appear on the secondary display.

To customize the columns in the Edit Index:
– To show or hide columns in the Edit Index: Right-click any column header, and choose the column you want to show or hide from the contextual menu. Checked columns are shown, unchecked columns are hidden.

To resize any column of the Edit Index:
– Move your pointer over the divider between any two columns and drag when the horizontal resize cursor appears.

To sort the Edit Index by any column:
– Click the Option button at the top right to display all active tracks, just the video, or just the audio tracks.

To rearrange Edit Index columns:
– Drag the header of any column to the left and right to move that column.

To show and hide the Audio Meters or Audio Mixer:
– Click the Mixer button in the UI toolbar.

To switch between the Audio Meters and the Audio Mixer:
– Choose Meters or Mixer from the Option menu at the top right corner of the Mixer.
Undo and Redo in DaVinci Resolve

No matter where you are in DaVinci Resolve, Undo and Redo commands let you back out of steps you’ve taken or commands you’ve executed and reapply them if you change your mind. DaVinci Resolve is capable of undoing the entire history of things you’ve done since creating or opening a particular project. When you close a project, its entire undo history is purged. The next time you begin work on a project, its undo history starts anew.

Because DaVinci Resolve integrates so much functionality in one application, there are three separate sets of undo “stacks” to help you manage your work.

– The Media, Edit and Fairlight pages share the same multiple-undo stack, which lets you backtrack out of changes made in the Media Pool, the Timeline, the Metadata Editor, and the Viewers.

– Each clip in the Fusion page has its own undo stack so that you can undo changes you make to the composition of each clip, independently.

– Each clip in the Color page has its own undo stack so that you can undo changes you make to grades in each clip, independently.

In all cases, there is no practical limit to the number of steps that are undoable (although there may be a limit to what you can remember). To take advantage of this, there are three ways you can undo work to go to a previous state of your project, no matter what page you’re in.

To simply undo or redo changes you’ve made one at a time:

– Choose Edit > Undo (Command-Z) to undo the previous change.

– Choose Edit > Redo (Shift-Command-Z) to redo to the next change.

– On the DaVinci control panel, press the UNDO and REDO buttons on the T-bar panel.

TIP: If you have the DaVinci control panel, there is one other control that lets you control the undo stack more directly when using the trackballs, rings, and pots. Pressing RESTORE POINT manually adds a memory of the current state of the grade to the undo stack. Since discrete undo states are difficult to predict when you’re making ongoing adjustments with the trackball and ring controls, pressing RESTORE POINT lets you set predictable states of the grade that you can fall back on.

You can also undo several steps at a time using the History submenu and window. At the time of this writing, this only works for multiple undo steps in the Media, Cut, Edit, and Fairlight pages.

To undo and redo using the History submenu:

1. Open the Edit > History submenu, which shows (up to) the last twenty things you’ve done.

2. Choose an item on the list to undo back to that point. The most recent thing you’ve done appears at the top of this list, and the change you’ve just made appears with a check next to it. Steps that have been undone but that can still be redone remain in this menu, so you can see what’s possible. However, if you’ve undone several changes at once and then you make a new change, you cannot undo any more and those steps disappear from the menu.
Once you’ve selected a step to undo to, the menu closes and the project updates to show you its current state.

**To undo and redo using the Undo window:**

1. Choose Edit > History > Open History Window.

2. When the History dialog appears, click an item on the list to undo back to that point. Unlike the menu, in this window the most recent thing you’ve done appears at the bottom of this list. Selecting a change here grays out changes that can still be redone, as the project updates to show you its current state.

3. When you’re done, close the History window.
Chapter 35

Creating and Working with Timelines

In this chapter, you’ll learn how to create and modify the timelines into which you edit clips to create the edited sequences that are your programs.

Contents

Keyboard Shortcuts in This Chapter 578
Creating and Duplicating Timelines 578
Individual Timeline Settings for Format, Monitoring, and Output 578
Creating Blank and Stringout Timelines 579
Creating Timelines by Drag and Drop 580
Creating Timelines From Bins and Selections 581
Creating Timelines Using an IMF or DCP Composition Playlist (CPL) 581
Duplicating Timelines 582
Disabling Timelines 582
Timeline View Options 582
Modifying Timeline Tracks 584
Naming Timeline Tracks 585
Using Timeline Snapping and Zooming 585
Zoom Around Mouse Pointer 586
Scrolling Through the Timeline 586
Scroll Wheel Controls on Timeline 586
Resizing the Timeline’s Video and Audio Track Regions 587
Tabbed and Stacked Timelines 587
Tabbed Timelines 587
Stacked Timelines 588
Duplicate Frame Detection 589
Comparing Timelines 589
The Timeline Comparison Window 589
Keyboard Shortcuts in This Chapter

Here's a list of keyboard shortcuts you might find helpful that relate to topics found in this chapter.

<table>
<thead>
<tr>
<th>Key Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command-N</td>
<td>Create new timeline</td>
</tr>
<tr>
<td>Delete/Backspace</td>
<td>Remove timeline from Media Pool</td>
</tr>
<tr>
<td>Command-Shift-N</td>
<td>Create new bin in Media Pool</td>
</tr>
<tr>
<td>Command-Minus (–)</td>
<td>Zoom out of timeline</td>
</tr>
<tr>
<td>Command-Equals (=)</td>
<td>Zoom into timeline</td>
</tr>
<tr>
<td>Shift-Z</td>
<td>Zoom all clips to available width of screen; toggles back to previous zoom level</td>
</tr>
<tr>
<td>Home</td>
<td>Move playhead to beginning of timeline</td>
</tr>
<tr>
<td>End</td>
<td>Move playhead to end of timeline</td>
</tr>
<tr>
<td>N</td>
<td>Toggle timeline snapping off and on</td>
</tr>
<tr>
<td>Command-Shift-L</td>
<td>Toggle linked selection off and on</td>
</tr>
<tr>
<td>Command-4</td>
<td>Select the timeline panel</td>
</tr>
</tbody>
</table>

Creating and Duplicating Timelines

If you’re not importing a project that’s been edited elsewhere, you can create a new timeline to cut together a new edit from scratch, to use to assemble clips for use in a Fusion composition, to grade a set of dailies, or to put together an audio program within the Fairlight page. When you create a new timeline, you can either create a timeline that contains all clips found in the Media Pool to quickly create a big batch of offline dailies, or an empty timeline that’s ready for you to add specific clips to. Timelines you create are stored in the currently selected Media Pool bin.

If you’d like an easy way to browse all the timelines in your project at once, regardless of their diverse locations, you can enable the “Smart Bin for Timelines” option, which is in the Editing panel of the User Preferences. This creates a Smart Bin in the Bin list of the Media Pool that filters all timelines in your project, making it easy to see all your timelines without altering your original organization.

Individual Timeline Settings for Format, Monitoring, and Output

When you create a new timeline, there are a number of ways you can customize it, but by default it’ll mirror the current project-wide timeline settings for resolution, frame rate, and other format and monitoring parameters.
The Create New Timeline dialog with standard customization settings

However, you have the option of creating separate timelines with individual Format (including Input Scaling), Monitoring, and Output Sizing settings, for situations where you need to set up multiple timelines to create multiple deliverables with different resolutions, pixel aspect ratios, frame rates, monitoring options, or output scaling options than the overall project, including "Mismatched Resolution Files" settings. To choose individual settings, uncheck the Use Project Settings box in the New Timeline dialog, and additional controls will appear.

Clicking Use Custom Settings exposes additional panels for individualized timeline settings

Once you’ve created a timeline with individual settings, you can edit its settings by right-clicking that timeline in the Media Pool, and choose Timelines > Timeline Settings from the contextual menu. An Edit Timeline dialog appears, with separate panels for Format, Monitor, and Output settings that you can choose.

You can also click Use Basic Settings to have that timeline use the project-wide timeline settings instead.

Creating Blank and Stringout Timelines

If you’re cutting a new video or audio program, you’ll usually want a blank timeline. However, the same command can be used to create stringout timelines when putting together dailies by turning the “Empty Timeline” checkbox off.
To create a new blank timeline:

1. (Optional) Select or create a folder in the Bin list in which to put the new timeline.

2. Do one of the following:
   - Right-click within the Media Pool, and choose Timelines > Create New Timeline.

3. When the New Timeline Options window opens, set the following options:
   - **Start Timecode:** You can change the Start Timecode if a specific start time is required.
   - **Timeline Name:** Enter a name into the Timeline Name field.
   - **No. of Video Tracks:** Enter how many video tracks you want to have. You can also drag within this field to adjust the number of video tracks with a virtual slider.
   - **Use Fairlight Preset:** If this box is checked, it creates a timeline with pre-assigned audio tracks using a previously created Fairlight Configuration preset. A drop-down menu then appears, allowing you to select the specific preset for the Timeline. The preset is used in lieu of the No. Of Audio Tracks setting below. You can create Fairlight Configuration presets using the Fairlight Presets Library, available from the Fairlight menu. For more information, see Chapter 168, “Setting up Tracks, Buses, and Patching” in the DaVinci Resolve Manual. If you have no Fairlight Configuration presets saved, this option will not appear.
   - **No. of Audio Tracks:** Enter how many audio tracks you want to have. You can also drag within this field to adjust the number of audio tracks with a virtual slider.
   - **Audio Track Type:** Choose the channel mapping you want the new audio tracks to use.
   - **Empty Timeline:** Checked by default, this sets new timelines to be created empty. If you turn off the Empty Timeline checkbox, the new Timeline that’s created will contain all media found in every bin within the Media Pool, effectively creating a stringout of everything you’ve imported.
   - **Use Selected Mark In/Out:** Only available when “Empty Timeline” is turned off. When you turn this checkbox on, each clip’s duration in the new Timeline is defined by the In and Out points saved within each clip. If there are no In/Out points in a clip, the clip’s entire duration is used.
   - **Use Custom Settings:** Click this button if you want to expose the Format, Monitor, and Output tabs that can expose unique settings for each timeline.

4. Click Create New Timeline.

A new timeline is created. If necessary, you can duplicate an existing timeline in order to alter an edit or create an alternate grade.

**TIP:** If you’re going to be creating several new timelines with a specific set of parameters, you can open the User pane of the Preferences and edit the New Timeline Settings, found in the Editing panel. This will define new presets that populate the New Timeline Options window from that point forward.

Creating Timelines by Drag and Drop

When you first create a new project, no timeline inhabits the Timeline Editor, and you have an opportunity to create a new timeline by drag and drop.

**To create a timeline by dragging and dropping a clip:**

Drag any clip into the empty Timeline Editor area underneath the Viewers on the Edit page, and a new timeline will automatically be created.
Creating Timelines From Bins and Selections

The “Create Timeline Using Bin” and “Create Timeline Using Selected Clips” commands let you quickly assemble a timeline using the contents of the Media Pool, using whatever In and Out points have been added to each clip, and using the sort order of the enclosing bin to determine the order in which the clips will be assembled.

TIP: These commands are especially useful for putting together quick assembly edits if you have metadata-rich media with scene, shot, and take information that you can use to sort clips into the proper order, and In and Out points that you’ve already logged.

To create a timeline using the full contents of a bin:

1. (Optional) Put the Media Pool into List mode, set In and Out points for each clip in your Bin, and sort the Media Pool by the column that will put all clips in the order you want them to be assembled.
2. Right-click the bin in the Bin list, and choose Create Timeline Using Bin.
3. Type the name of the new timeline in the New Timeline Properties dialog. If you want to use the In and Out points of each clip, make sure “Use Selected Mark In/Out” is checked, and click Create New Timeline.

To create a timeline using manually selected clips:

1. (Optional) Put the Media Pool into List mode, set In and Out points for each clip in your Bin, and sort the Media Pool by the column that will put all clips in the order you want them to be assembled.
2. Select one or more clips you want to assemble into a new timeline.
3. Right-click one of the selected clips, and choose Create Timeline Using Selected Clips.
4. Type the name of the new timeline in the New Timeline Properties dialog. If you want to use the In and Out points of each clip, make sure “Use Selected Mark In/Out” is checked, and click Create New Timeline. By default, Audio Track Type is set to “Based on selected media,” so the timeline audio tracks reflect the track mapping of the clips you’ve selected, but you can manually choose other specific mappings if you need to.

Creating Timelines Using an IMF or DCP Composition Playlist (CPL)

You can create a timeline in DaVinci Resolve that exactly replicates the Composition Playlist (CPL) of a DCP or IMF package. This is currently a DaVinci Resolve Studio only feature.

To create a timeline using a Composition Playlist (CPL):

1. Import an IMF or DCP package into the Media Pool, like any other piece of media.
2. Right-click on the imported clip and choose “Create New Timeline Using Composition Playlist” from the contextual menu.
3. In the New Timeline dialog box, choose a specific CPL from the package in the “Composition Playlist” drop-down menu.
4. Make any other normal new Timeline adjustments you may need (such as Resolution, Aspect Ratio, etc.), then click the “Create” button.
Duplicating Timelines

You can also duplicate existing timelines in preparation for saving a copy prior to making modifications, or as a starting point for a different version of your content.

To duplicate a Timeline, do one of the following:

– Select a timeline in the Media Pool, and choose Edit > Duplicate Timeline. The duplicate timeline appears with “copy” appended to the name.

– Right-click a timeline in the Media Pool, and choose Duplicate Timeline from the contextual menu.

Disabling Timelines

You can disable/enable timelines in the Media Pool for both performance and organizational purposes. This is particularly useful for editors who like to maintain a history of a program’s editing via an ongoing series of periodically duplicated timelines. Since having a large number of timelines within a single project file can affect performance, having the ability to disable timelines lets you maintain these backup/alternate timelines without any penalty.

Disabled timelines are never loaded into RAM, have no effect on the speed at which a project opens, saves, exports, or loads, and have no effect on program performance. A disabled timeline also hides the timeline from the viewer drop-down menus throughout the program. Disabled timelines are still visible in the Media Pool, but have a crossed out eye icon in the lower left to show the status. A disabled timeline cannot be opened in any page of DaVinci Resolve.

To disable a timeline:

– Select the Timeline, right-click on it and choose “Disable Timeline” from the drop-down menu.

To enable a timeline:

– Select the Timeline, right-click on it and choose “Enable Timeline” from the drop-down menu.

Timeline View Options

As you’re working on an edit, it can often be useful to modify the appearance of the Timeline, changing the height of video or audio clips, choosing whether audio waveforms are drawn or not, and so on. Using the Timeline View Options drop-down at the far left of the Timeline, you can make these kinds of changes as you work.
You have the following options:

- **Timeline View Options**: Three buttons let you choose to show or hide specific Timeline interface elements, including the following:
  - Show tabbed and stacked timelines: This option lets you open multiple timelines by displaying a tabbed interface, and also gives you the ability to show stacked timelines for simultaneous display of timelines one on top of another.
  - Subtitle Tracks: Lets you display or hide the subtitle tracks region of the Timeline. Hiding subtitle tracks does not disable subtitle display; to do that you must disable the currently displayed subtitle track.
  - Show Audio Waveforms: Lets you turn audio waveform viewing off and on. When Audio Waveform is turned off, audio tracks are minimized.

- **Video View Options**: Three buttons let you choose the overall appearance of video and audio tracks. From left to right:
  - Filmstrip: Displays each clip as a series of frames along its length. The number of frames displayed depends on the current zoom level of the clip in the Timeline.
  - Thumbnail: Displays each clip as a solid color with a thumbnail image of the clip’s In point at the beginning of the clip, and a thumbnail image of the Out point at the end. The thumbnails displayed depend on the current zoom level, and track height of the clip in the Timeline. If the clip does not have enough room for both, only the In point thumbnail will appear.
  - Simple: Minimizes all track height and displays each clip as a solid color along its length. Hovering the mouse over the track selection indicator will reveal the track names in a tooltip.

- **Audio View Options**: Three buttons govern the look of audio waveforms in the Timeline, when visible.
  - Non-Rectified Waveform: Lets you toggle between the waveform being drawn from the bottom of the audio track up, or centered and mirrored about itself.
  - Full Waveform: Hides the divider bar that keeps the waveform separate from the file name area of each audio clip, so the waveform occupies the full space of each audio bar in the Timeline.
  - Waveform Border: Draws a dark border around the edges of each waveform to make them easier to see.
– **Video track height slider**: Lets you resize the size of all video tracks at once, independently of the audio tracks.

– **Audio track height slider**: Lets you resize the size of all audio tracks at once, independently of the video tracks.

In addition, any track in the Timeline can be individually resized by dragging its top divider in the Track Header area. Track heights in the Edit page are independent of the Thumbnail and Waveform view settings in the Timeline View options. Previously, specific Timeline viewing options such as Filmstrip or Thumbnail view had minimum track height settings. Now you can freely change track height no matter what options you’ve chosen, and resizing one or more tracks below the minimum height for filmstrips or thumbnails automatically collapses those tracks into Simple view to avoid clutter.

Modifying Timeline Tracks

When you’re getting ready to edit clips into the Timeline, you need to make sure you’ve got enough tracks to do the job. The following procedures cover the different methods available for adding, removing, and rearranging tracks as you work. These commands are all available via the contextual menu that appears when you right-click anywhere in the Timeline header area (the header of the Timeline is the area to the left where each track’s various buttons and controls are located).

**Methods for adding, deleting, and rearranging tracks:**

– **To add a track to the Timeline**: Right-click anywhere in the Timeline header and choose Add Track. If you add an audio track, you can choose what type of channel mapping you want. For more information about audio track channel mappings, see Chapter 45, “Working with Audio in the Edit Page.”

– **To add multiple tracks to the Timeline at a specific position**: Right-click anywhere in the Timeline header and choose Add Tracks. When the Add Tracks dialog appears, choose the number of video and audio tracks you want to add, choose the position you want to insert the tracks above or below, and choose the Audio Track Type you want to add if you’re adding audio tracks. When you’re done, click “Create New Tracks.”

– **To delete a track from the Timeline**: Right-click within a track’s Timeline header and choose Delete Track. If there are clips on a track you remove, they are deleted from the Timeline.

– **To delete all unused tracks in the Timeline**: Right-click anywhere in the track header area and choose Delete Empty Tracks. All tracks without clips will be deleted at once.

– **To move tracks and the clips on them up and down**: Right-click within a track’s Timeline header and choose Move Track Up or Move Track Down from the contextual menu. That track, along with all clips on it, will be moved up or down relative to the other tracks in the Timeline.
Naming Timeline Tracks

If you’re a stickler for organization, you can also name the tracks on a timeline to identify its purpose.

To rename a track:
1. Make sure the Timeline View Options are set to either the Filmstrip view or the Thumbnail view, and that audio tracks are tall enough, so that track names are visible.
2. To edit the name of any track, click the default “Video X” or “Audio X” track name to select it, then type your preferred name and press the Return key.

Using Timeline Snapping and Zooming

When preparing to make an edit into the Timeline, you can set the snapping and zoom controls to whichever state is most useful for the operation you need to perform. For example, if you’re editing an insert shot into a rapid-fire section of edits in the Timeline, you may want to zoom in to better see the exact place where you want to place the incoming clip. Since there are many edits at that point, disabling snapping might make it useful to avoid having the clip jump to the nearest edit point if you need to move the incoming clip to a very specific frame.

Playhead Snapping:
- To turn clip and playhead snapping on and off: Click the Snapping button in the toolbar, or press N. When snapping is turned on, the In and Out points and markers of clips all snap to one another and to the playhead. You can also press N to temporarily turn snapping on or off while dragging a clip in the Timeline, or while scrubbing the playhead using the pointer (snapping reverts to its previous state when you finish the operation).

Timeline Zoom Presets:
- **Full Extent Zoom:** This mode dynamically adjusts the zoom level to encompass the whole Timeline as you add or remove clips. As your timeline grows by adding clips, the zoom level decreases automatically to fit the new clips into your Timeline Viewer. Conversely, the zoom level will increase automatically as you remove clips.
- **Detail Zoom:** This setting zooms the Timeline in on the Playhead to the frame level to quickly make fine timing adjustments.
- **Custom Zoom:** Zooms the Timeline to the level selected by the Zoom Slider to its immediate right.
- **Zoom Slider:** Drag the zoom slider to the left to zoom out, and right to zoom in. You can also press Command-Minus (−) and Command-Equal (=) to zoom out and in. Either way, zooming is always centered on the current position of the playhead, even if the playhead is off screen.
To frame every clip into the width of the Timeline: Press Shift-Z. This is a toggle, so pressing Shift-Z frames your whole edited sequence to the width of the Timeline, and then pressing Shift-Z again returns the Timeline to whatever level of zoom you were using previously. Using this keyboard shortcut makes it really easy to navigate the Timeline when you’re zoomed in, as you can press Shift-Z, move the playhead to another part of the Timeline you want to work on, and then press Shift-Z again to zoom back into the new location of the Timeline.

Zoom Around Mouse Pointer

You can set up the Edit Timeline zoom controls to stay centered on the pointer as you zoom in or out, instead of staying centered on the Timeline playhead as usual, by selecting View > Zoom Around Mouse Pointer. This can be helpful when navigating longer timelines.

With this option enabled, zooming in and out of the Timeline using the scroll control of your pointing device while holding the Option key down keeps the Timeline centered on the pointer. Deselect this option to return to the behavior of only zooming in or out centered on the playhead position.

Scrolling Through the Timeline

When you’re zoomed into the Timeline, there are several methods you can use to scroll around as you work.

- You can scroll left and right, or up and down, by dragging the Timeline’s horizontal and vertical scroll bars.
- You can also scroll up and down the tracks of the Timeline using the scroll wheel, scroll ball, or scroll gestures of your mouse, trackball, trackpad, or other pointing device.
- You can also scroll within the Timeline by middle-clicking and dragging in any direction, which works the same as panning around a viewer that you’ve zoomed into. This frees you from having to use the scroll bars as you move around your edited clips.

If you scroll past the position of the playhead, a small playhead indicator appears in the bottom scroll bar to let you know where it is relative to the entire duration of your edited sequence.

Scroll Wheel Controls on Timeline

Additional scroll wheel and key presses can be used to manipulate the Timeline on the Edit page.

To manipulate the Timeline, rotate the scroll wheel while holding down:

- **Shift:** Expands or contracts all the Video or Audio track heights, depending on what section the pointer is located at when you scroll.
- **Option:** Zooms in and out the view of the Timeline.
- **Command:** Navigates forward and backward in the Timeline.
Resizing the Timeline’s Video and Audio Track Regions

If you need to see more of the video or audio tracks in the available area of the Timeline, you can drag the horizontal divider that separates the audio and video tracks up or down to create room where you need it.

Tabbed and Stacked Timelines

The Timeline now supports the option to have tabs that let you browse multiple timelines quickly. With tabbed timeline browsing enabled, a second option lets you open up stacked timelines to simultaneously display two (or more) timelines one on top of another.

Tabbed Timelines

The Timeline View Options menu in the toolbar has a button that lets you enable tabbed browsing and the stacking of timelines.

When you first turn this on, a Timeline tab bar appears above the Timeline, displaying a tab for the currently open timeline that contains a Close button and a Timeline drop-down menu. Once you enable Tab mode, opening another timeline from the Media Pool opens it into a new tab.

To the right of the currently existing tabs, an Add Tab button lets you create additional tabs that default to “Select Timeline.” Click any tab’s drop-down menu to choose which timeline to display in that tab.
**Methods of working with tabbed timelines:**

– Click any tab to switch to that timeline.

– Use the drop-down menu within any tab to switch that tab to display another timeline from the Media Pool. Each tab's drop-down menu shows all timelines within that project, in alphabetical order, but a timeline can only be open in one tab or stack at a time.

– Drag any tab left or right to rearrange the order of timeline tabs.

– Click any tab's Close button to close that timeline and remove that tab.

**Stacked Timelines**

While tabbed browsing is turned on, an Add Timeline button appears on the far right of the tab bar that enables you to stack two (or more) timelines one on top of another. This lets you have two (or more) timelines open at the same time, making it easy to edit clips from one timeline to another.

A good example of when this is useful is when you’ve created a timeline that contains a stringout of selects from a particular interview. You can stack two Timeline Editors, one on top of another, and then open the Selects Timeline at the top and the Timeline you’re editing into at the bottom. With this arrangement, it’s easy to play through the top timeline to find clips you want to use, to drag and drop into the bottom timeline to edit into your program.

![Two timelines stacked on top of one another](image)

**To enable or disable stacked timelines:**

– Click the Add Timeline button at the right of the Timeline tab bar.

![The button for adding a stacked timeline](image)

Once you’ve enabled stacked timelines, each timeline has its own tab bar and an orange underline shows which timeline is currently selected.

At the right of each Timeline tab bar, a Close Timeline button appears next to the Add Timeline button, which lets you close any timeline and remove that timeline browsing area from the stack.

![The button for closing a stacked timeline](image)
Duplicate Frame Detection

You can turn on Duplicate Frame Detection (often referred to as Dupe Detection) for clips in the Timeline by choosing View > Show Duplicate Frames. Doing so shows colored bars at the top of clips in the Timeline whenever a range of frames has been used more than once.

Comparing Timelines

For instances where you’re importing multiple versions of a timeline that’s been edited in another application, or where you’re working with multiple editors on different versions of the same Timeline in either collaborative mode or on multiple separate DaVinci Resolve installations, DaVinci Resolve provides a method of comparing two timelines with one another. Using the Timeline Comparison window, you can both see a visual comparison of which sections of two timelines differ, and you can derive a more traditional change list by opening up the Difference Index.

To compare two timelines:

1. Open the first timeline you want to compare.
2. Right-click a second timeline in the Media Pool, and choose Compare With Current Timeline.

A Timeline Comparison window appears, showing you the currently opened Timeline at the bottom and the Timeline you right-clicked at the top.

The Timeline Comparison Window

When you first open the Timeline Comparison window, the first thing you see is a pair of miniature timelines. The currently open Timeline appears at the bottom and the Timeline you right-clicked appears at the top.
Comparison Window Playhead Output
By default, the two playheads are ganged together, with the top playhead being displayed in the Source Viewer, and the bottom playhead being displayed in the Timeline Viewer. These playheads can be unganged if you want to compare different areas of both timelines, simply by turning off Sync Playheads in the option menu.

Highlighting Differences
Special highlights indicate sections of both timelines that are different. Individual changes are not individually highlighted, although they can be seen, on the premise that you’re more interested in a section by section analysis of what your collaborating editor has been doing, for purposes of deciding whether to incorporate changes or reversions based on this comparison.

Each section of differences between the two timelines are highlighted

When using this tool, you can change the bottom Timeline to match the top Timeline, on a section by section basis, by right-clicking a highlighted section and choosing Accept Change from the contextual menu. When you do this, the currently open Timeline is immediately changed to incorporate the altered section from the Timeline you’re comparing to. If necessary, you can undo this.

Identifying Differences Using Clip Labelling
You can also use the Timeline Comparison window to use clip labeling to indicate all differences between the comparison Timeline and the currently open Timeline. The method for doing this has not yet been defined at the time of this writing.

The Change List
Clicking the Diff Index button opens the change list, which shows you a more conventional item by item comparison of the differences between the two timelines.

The method of exporting this change list has not yet been defined at the time of this writing.
Chapter 36

Preparing Clips for Editing and Viewer Playback

Before you start editing, there are a wide variety of things you can do to prepare your clips for editing. In this chapter, you’ll learn how to browse, select, and play through clips that you need to log, adding markers, setting In and Out points, and creating subclips as you identify pieces you’ll be using later as you edit.

Contents

Keyboard Shortcuts in This Chapter 592
Browsing Clips in the Media Pool 593
Selecting Clips in the Media Pool to Edit 594
Duplicating Clips in the Media Pool 595
Viewer Playback and Navigation 595
Source and Timeline Viewers vs. Single Viewer Mode 595
Opening Clips Into the Source Viewer to Prepare for Editing 596
Viewer Transport Controls 597
Simple Keyboard Shortcuts for Playback and Navigation 598
Using JKL to Control Playback 599
Special-Purpose Playback Commands 599
Option to “Stop and Go to Last Position” 600
Enabling and Disabling Audio Scrubbing 600
Playback Post-Roll 600
Moving the Playhead Using Timecode 601
How to Enter Timecode Values 601
Absolute Timecode Entry 601
Relative Timecode Entry
Copy and Paste Timecode in Viewer Timecode Fields
Gang Viewers (Playhead Ganging)
Adding Markers
Adding Markers to Clips
Setting In and Out Points
Setting Clip In and Out Points in the Media Pool
Setting Clip In and Out Points in the Source Viewer
Clearing and Navigating In and Out Points
Clip Edit Points Are Saved
Turning In and Out Points into Markers With Duration and Back Again
Organizing Media by Creating Subclips

Keyboard Shortcuts in This Chapter

Here's a list of keyboard shortcuts you might find helpful that relate to topics found in this chapter.

<table>
<thead>
<tr>
<th>Key Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow Keys (Media Pool)</td>
<td>Move selection in Media Pool; left and right arrow keys also open and close bins in the Bin list</td>
</tr>
<tr>
<td>Shift (modifier)</td>
<td>Hold Shift down when clicking-to-select clips to select a contiguous range</td>
</tr>
<tr>
<td>Command (modifier)</td>
<td>Hold Command down when clicking-to-select clips to select non-contiguous clips</td>
</tr>
<tr>
<td>Command-A</td>
<td>Select all; selects all clips in the Media Pool browser area</td>
</tr>
<tr>
<td>Return or Enter</td>
<td>Opens selected clip or timeline into the Source Viewer (in dual viewer mode) or Viewer</td>
</tr>
<tr>
<td>I, O</td>
<td>Set in/out point in Media Pool, Source Viewer, or Timeline</td>
</tr>
<tr>
<td>Option-Shift-I, O</td>
<td>Set video-only in/out point in Media Pool, Source Viewer, or Timeline</td>
</tr>
<tr>
<td>Command-Shift-I, O</td>
<td>Set audio-only in/out point in Media Pool, Source Viewer, or Timeline</td>
</tr>
<tr>
<td>Shift-I, O</td>
<td>Move playhead to in/out point</td>
</tr>
<tr>
<td>Spacebar</td>
<td>Play and stop</td>
</tr>
<tr>
<td>J, K, L</td>
<td>Play reverse, stop, play forward; more uses covered later in this chapter</td>
</tr>
<tr>
<td>Option-L</td>
<td>Play again</td>
</tr>
<tr>
<td>Option-K</td>
<td>Stop and go to last position (of playhead)</td>
</tr>
<tr>
<td>/</td>
<td>Play around current selection</td>
</tr>
<tr>
<td>Up, Down Arrow</td>
<td>Go to previous clip/edit, go to next clip/edit</td>
</tr>
<tr>
<td>M</td>
<td>Add marker; doesn’t stop playback</td>
</tr>
<tr>
<td>Command-M</td>
<td>Add marker, open modify marker while pausing playback, then continue playback</td>
</tr>
<tr>
<td>Shift-M</td>
<td>Modify marker</td>
</tr>
<tr>
<td>Option-M</td>
<td>Delete marker</td>
</tr>
<tr>
<td>Shift-Up, Down Arrow</td>
<td>Go to previous/next marker</td>
</tr>
<tr>
<td>Option-B</td>
<td>Create subclip (in currently selected Media Pool bin)</td>
</tr>
</tbody>
</table>
Browsing Clips in the Media Pool

The following procedures show how to select one or more clips in the Media Pool to accomplish various editing tasks, either by opening a clip in the Source Viewer, or selecting a group of clips with which you want to do drag and drop editing. This section starts by presenting different ways you can browse the contents of the Media Pool to find clips you want to use, in preparation for making a selection for your next operation.

Methods of browsing clips in the Media Pool:

In the Metadata View mode, each clip is represented by its own card with a thumbnail and basic clip metadata information visible. This view is designed to have more metadata information than a thumbnail but more targeted information than the List view. This feature, combined with its Sort modes, is a powerful way to organize and reorganize your clips in the Media Pool.

– Using thumbnail hover scrub in the Media Pool’s Metadata view: Drag the pointer over a thumbnail to scrub through its contents.

![The Metadata View icon view (highlighted icon in the top bar), showing the thumbnail being scrubbed next to the clip's metadata](image)

– Using thumbnail hover scrub in the Media Pool’s Thumbnail view: Drag the pointer over a thumbnail to scrub through its contents.

![Thumbnail hover scrubbing](image)

– Using the Media Pool Filmstrip in the Media Pool’s List view: Select “Show Filmstrip” in the Media Pool’s option menu. Select a clip to expose it in the Filmstrip at the top of the Media Pool, and hover the pointer over the Filmstrip to watch it play. At any time, you can double-click a clip in the Filmstrip to open it into the Source Viewer.

![Using the Filmstrip when the Media Pool is in List view](image)
TIP: When browsing media, you can open clips you want to have a closer look at in the Source Viewer by double-clicking them in the Media Pool. Meanwhile, you can continue to open other clips in the Filmstrip with a single clip in order to compare different clips with your main selection that remains in the Viewer.

Selecting Clips in the Media Pool to Edit

Once you’ve found one or more clips that you want to use in your edit, you’ll need to make a selection in preparation for performing an edit.

Methods of selecting clips in the Media Pool using the mouse:

– **To select a single clip:** Click a clip in the Media Pool.

– **To select a contiguous range of clips:** In either Metadata, Thumbnail, or List view, drag a selection box over all the clips you want to select, or click to select the first clip in a series, then Shift-click the last clip to select those clips and everything in between.

– **To select a noncontiguous range of clips:** Command-click each clip you want to include in the selection. Or, you can hold the Command key down while you drag bounding boxes over unselected clips to add them to the current selection, or over selected clips to remove them from the selection.
Methods of selecting clips using the keyboard:

– **To navigate the Bin list:** Either click any bin in the Bin list to the left of the Media Pool, or press Command-1 to make the Bin list the active pane of the Edit page, then use the Up and Down Arrow keys to to move up and down among the available bins. Use the Right Arrow key to open a bin that’s closed, and use the Left Arrow key to close the bin again.

– **To select a single clip:** Press Command-1 to make the Media Pool Bin list the active area, and use the arrow keys to select and open bins. Then press Command-2 to select the clip browser area and use the Arrow keys to move the selection from clip to clip. Once a clip is selected, you can use any of the edit keyboard shortcuts to edit the selected Media Pool clip straight to the currently open Timeline.

– **To select multiple clips:** Hold the Shift key down while you’re using the Arrow keys to move the selection to expand or contract a continuous selection in the Media Pool.

– **To select all clips in the Media Pool:** Make sure the Media Pool has focus by clicking a clip or clicking anywhere in the background of the Media Pool, then press Command-A to select all clips.

– **To open a selected clip or timeline into the Source Viewer:** Press the Return key. Once you’ve opened a clip into the Source Viewer, you can use the transport controls to play through it.

Duplicating Clips in the Media Pool

If you want to create duplicates of clips in the Media Pool, you can Option-drag one or more clips to another bin. You can also select the clip or clips you want to duplicate and select Edit > Duplicate Clips. The duplicated clips will appear in the same bin as the original media. The duplicate clips have their own individual links to the source media on disk.

Viewer Playback and Navigation

By default, the Edit page presents a traditional source/record style editing experience. The Source Viewer lets you view individual clips from the Media Pool to prepare them for editing. Meanwhile, the Timeline Viewer lets you play through your program, showing you the frame at the position of the playhead in the Timeline.

Source and Timeline Viewers

Source and Timeline Viewers vs. Single Viewer Mode

If you want to change the Edit page layout to hide the Source Viewer, you can choose Workspace > Single Viewer Mode to instead use just a single viewer to contextually display either a selected Source Clip or the current frame of the Timeline.
In Single Viewer mode, whatever you select in the Media Pool or Timeline determines which controls appear in the Viewer, which lets you do nearly everything you can do with two simultaneously open viewers.

### Opening Clips Into the Source Viewer to Prepare for Editing

Once you’ve decided which clips you want to use in your program, you can open them into the Source Viewer to review them more completely. How this works depends on the Source Viewer’s Live Media Preview setting.

#### To skim through a Media Pool metadata or thumbnail and view clips in the Source Viewer using Live Media Preview:

1. Turn on Live Media Preview (if necessary) by clicking the Source Viewer option menu and choosing Live Media Preview.
2. With the Media Pool open and in Metadata or Thumbnail mode, position the pointer over a clip, and after a few moments when that clip’s thumbnail starts to skim, you can see the clip you’re scrubbing in the Source Viewer. Do one of the following:
   a. As you skim within the thumbnail, the playhead that appears in the thumbnail is locked to the playhead displayed in the Viewer’s jog bar. While skimming, you can add markers and set In and Out points
   b. Leaving the pointer positioned over that clip, use the JKL keyboard shortcuts to play through the clip, adding markers and setting In and Out points as you like
3. It takes a moment for skimming to begin, which allows you to quickly move the pointer from that clip back to the Source Viewer without opening any other clip.

Turning off Live Media Preview lets you use more traditional and controlled methods of opening clips into the Source Viewer.

#### To open a clip into the Source Viewer using the mouse:

- Double-click any clip in the Media Pool, or in the Filmstrip of the Media Pool, to open it into the Source Viewer.
To open a clip into the Source Viewer using the keyboard:

1. If necessary, press Command-1 to select the Bin list, and press the Up and Down arrows to choose a folder to view its contents. Press the Right Arrow key to open folders and show any nested folders within, or the Left Arrow key to close folders and hide their nested contents.

2. Press Command-2 to select the Media Pool browser, and use the Arrow keys to change the selection from clip to clip in the Media Pool, up, down, left, and right.

3. When the clip you want is highlighted, press Return to open it into the Source Viewer.

To open a timeline into the Source Viewer:

- Drag and drop any timeline into the Source Viewer in preparation for either ganging it to the existing Timeline, or editing it, in whole or in part using In and Out points, into the currently open Timeline.

Monitoring with an External Video Display

While working in the Edit page, the image that’s displayed on an external video display (if one is connected) is determined either by the current selection in the Media Pool, or by which part of the Edit page interface has focus. For example, if you select a clip in the Media Pool so it’s displayed within the Filmstrip, that clip is output to video. If you then open it into the Source Viewer, then the contents of the Source Viewer are output to video. If you switch to the Timeline Viewer, then your timeline is output to video.

Viewer Transport Controls

The Edit page has two Viewers. The left Viewer, when you’re editing, should be set to show either source video or source audio, so it shows the source clip in any edit you’re setting up. At right is the Timeline Viewer, that shows the frame at the current position of the playhead in the Timeline. Using the Source and Timeline Viewers, you can set up a wide variety of edits.

There are identical transport controls underneath each of the Viewers.

The transport controls at the bottom of the Source Viewer

A jog bar appears directly underneath the transport controls, letting you drag the playhead directly with the pointer. The full width of the Source Viewer’s jog bar represents the full duration of a clip, while the full width of the Timeline Viewer’s jog bar represents the full duration of the current timeline. The current position of each playhead is shown in the timecode field at the upper right-hand corner of each viewer.

A separate jog control, to the left of the other transport controls, provides a way to jog more slowly through long clips or a long timeline. Click and drag to the left and right to move through a clip or the Timeline a frame at a time.

Transport controls appear above the jog bar. In the Source Viewer, these controls let you Jump to the First Frame, Play Reverse, Stop, Play Forward, and Jump to the Last Frame. In the Timeline Viewer,
these controls move to the Previous Edit, Play Reverse, Stop, Play Forward, and move to the Next Edit. A loop control governs the looping behavior during playback.

**Simple Keyboard Shortcuts for Playback and Navigation**

There are many different keyboard shortcuts you can use to simply navigate clips and timelines, and control playback.

- **Spacebar**: You can use the Spacebar to start and stop playback.
- **Play Again**: Press Option-L to immediately restart playback from where the playhead began without stopping; for instances where you quickly want to replay the beginning of what you’re listening to.
- **Step One Frame Forward/Step One Frame Back**: The Left Arrow and Right Arrow keys move the playhead back and forth one frame at a time, while Shift-Left Arrow and Shift-Right Arrow move the playhead in one-second increments.
- **Step One Second Forward/Step One Second Reverse**: Shift-Left Arrow and Shift-Right Arrow moves the playhead back and forth one second at a time.
- **Next Edit/Previous Edit**: Up Arrow moves the playhead to the previous edit and selects the edit point, while Down Arrow moves the playhead to the next edit and selects the edit point.
- **First Frame/Last Frame of the Current Clip**: The Semicolon key moves the playhead to the first frame of the clip intersecting the playhead, while the Apostrophe key moves the playhead to the last frame of the clip intersecting the playhead.
- **Previous Keyframe/Next Keyframe**: Shift-Semicolon moves the playhead to the next previous keyframe on the left when keyframes are displayed in the Timeline, while Shift-Apostrophe moves the playhead to the next keyframe to the right.
- **Previous Marker/Next Marker**: If there are markers in either the Timeline Ruler or within clips in the Timeline, Shift-Up Arrow and Shift-Down Arrow moves the playhead left and right from one marker to the next.
- **Previous Gap/Next Gap**: If any tracks of the Timeline that have Auto Select control enabled have gaps between clips, Option-Command-Semicolon and Option-Command-Apostrophe moves the playhead left and right from one gap to the next.
- **Timeline Start/Timeline End**: The Home key moves the playhead to the first frame of the Source or Timeline Viewer, while the End key moves the playhead to the last frame of the Source or Timeline Viewer.

Go to

- **In Point/Go to Out Point**: Shift-I moves the playhead to the In point set in either the Viewer or the Timeline. Shift-O moves the playhead to the Out point.

**TIP**: One of the options in the Editing panel of the User Preferences window, “Always highlight current clip in the media pool,” lets you decide whether the current selection in the Timeline is mirrored in the Media Pool.
Using JKL to Control Playback

The JKL keyboard shortcuts are common to many editing applications, and experienced editors know these to be some of the most useful controls for playback and editing there are. Here’s a list of the many different ways you can use these three keyboard shortcuts to play through clips and timelines as you work.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J</td>
<td>Plays 100% backward</td>
</tr>
<tr>
<td>K</td>
<td>Stops playback</td>
</tr>
<tr>
<td>L</td>
<td>Plays 100% forward</td>
</tr>
<tr>
<td>Press J repeatedly</td>
<td>Increases backward play speed each time you press J, for a range of fast-reverse speeds</td>
</tr>
<tr>
<td>Press L repeatedly</td>
<td>Increases forward play speed each time you press L, for a range of fast-forward speeds</td>
</tr>
<tr>
<td>Shift-J</td>
<td>Plays in fast reverse</td>
</tr>
<tr>
<td>Shift-L</td>
<td>Plays in fast forward</td>
</tr>
<tr>
<td>Shift-K</td>
<td>Play Slow at 1/2, 1/4 or 1/8 speeds</td>
</tr>
<tr>
<td>Press and hold K+J</td>
<td>Plays backward at slow motion (with slow motion audio playback)</td>
</tr>
<tr>
<td>Press and hold K+L</td>
<td>Plays forward at slow motion (with pitch-corrected audio playback on macOS)</td>
</tr>
<tr>
<td>Pressing K while tapping J</td>
<td>Moves the playhead back one frame</td>
</tr>
<tr>
<td>Pressing K while tapping L</td>
<td>Moves the playhead forward one frame</td>
</tr>
<tr>
<td>Command-J and Command-L</td>
<td>Holding the Command key down while using the J and L keyboard shortcuts lets you dynamically resize or trim selected edit points or clips at 100 percent or faster speed, depending on whether the Selection or Trim tool is enabled. For more information on dynamic trimming, see Chapter 44, “Trimming.”</td>
</tr>
</tbody>
</table>

When you’re playing back at faster or slower than real-time speed using the JKL commands, a speed indicator appears to the right of the frame per second indicator of the Viewer.

A speed indicator above the Viewer shows that you’re playing at 4x speed

Once you learn all the different methods of JKL playback, they will probably become one of the main ways you move the playhead around in DaVinci Resolve.

Special-Purpose Playback Commands

In addition to the standard transport controls, there are some additional playback controls, available via keyboard shortcuts or the Playback menu, that let you perform different playback operations.

- **Loop**: Command-Forward Slash (/). Toggles looped playback off and on. While looped playback is on, playback initiated with any of the following commands will loop automatically until you stop playback.
– **Play around selection**: Forward Slash (/). This command works contextually depending on what’s selected in the Timeline. Plays a section of the Timeline from x frames before to y frames after (a) the playhead (if nothing’s selected), (b) the currently selected edit point, (c) the currently selected clip, (d) a selection of multiple clips. This command is useful for previewing how the current selection plays within the context of the clips immediately surrounding it. The pre-roll and post-roll time is customizable in the Editing panel of the User Preferences.

– **Play around current frame**: Plays a section of the Timeline from x frames before to y frames after the current position of the playhead. This command is useful for previewing how edits play within the context of the clips immediately surrounding them. The pre-roll and post-roll time is customizable in the Editing panel of the User Preferences.

– **Play around current clip**: (no default key assigned). Plays a section of the Timeline from x frames before to y frames after the current clip intersecting the position of the playhead. The pre-roll and post-roll time is customizable in the Editing panel of the User Preferences.

– **Play Around In**: Option-Space. Plays a section of the Timeline from x frames before to y frames after the current assigned In point, letting you preview the transition from one clip to the next. The pre-roll and post-roll time is customizable in the Editing panel of the User Preferences.

– **Play Around Out**: Shift-Space. Plays a section of the Timeline from x frames before to y frames after the current assigned Out point, letting you preview the transition from one clip to the next. The pre-roll and post-roll time is customizable in the Editing panel of the User Preferences.

– **Play In to Out**: Option-Forward Slash (/). If you’ve marked a section of a clip or timeline with In and Out points, this command lets you preview how it will play.

– **Play to In**: (no default key assigned). Initiates playback and stops at the current In point.

– **Play to Out**: Option-Command-Forward Slash (/). Initiates playback and stops at the current Out point.

### Option to “Stop and Go to Last Position”

Playback > Stop and Go to Last Position lets you set DaVinci Resolve to a mode where the playhead returns to where playback began whenever you stop. This option is most useful when editing audio, although it’s available any time.

This option is also available when you right-click on the Stop button in the transport controls of any viewer. A contextual menu appears where you can turn “Stop and go to last position” on or off as the default behavior.

### Enabling and Disabling Audio Scrubbing

Audio scrubbing is enabled by default, meaning that you’ll hear audio when dragging the playhead with the mouse back and forth. While this can be useful when you’re searching for audio cues, it can also be distracting if you’re just focused on the picture.

**To enable or disable audio scrubbing:**

– Choose Timeline > Audio Scrubbing (Shift-S).

### Playback Post-Roll

Enables the playhead to continue playing past the last clip in the Timeline for a duration equal to the “Post-roll time” Project Setting in the Editing panel. This is good for editors that want to experience a few moments of playback after cutting or fading to black after the last frame of audio and video in the Timeline.

**To enable or disable Playback Post-Roll:**

– Choose Timeline > Playback Post-Roll.
Moving the Playhead Using Timecode

You can use absolute or relative timecode entry to either move the playhead in both the Source and Timeline Viewers, or to move or trim selected edit points or clips. When navigating the Timeline, timecode entry lets you move the playhead very precisely, or jump to specific timecode values really quickly.

**TIP:** The method of timecode entry described here is used for many different commands that require timecode entry and is designed for fast and efficient editing.

How to Enter Timecode Values

When entering timecode, type each pair of hour, minute, second, and frame values from left to right, with a period representing a pair of zeroes for fast entry. The numbers you enter appear in the timecode field at the upper right-hand corner of the Viewer with focus. When you’re finished typing, press the Return key to execute the timecode command. The rules for timecode entry are as follows:

- The right-most pair of timecode values (or period) you enter is always the frame number.
- A period to the left or to the right of any number you type is considered to be a pair of zeroes.
- A single period between two numbers is considered to either be a single zero, or ignored if it’s between two pairs of numbers.
- Any untyped pairs of values to the left of what you enter are assumed to be whatever those values were prior to the timecode you entered; this makes it easy to type partial timecode values even when the Timeline starts at hour one.
- It’s not necessary to enter colons or semicolons.

Absolute Timecode Entry

Absolute timecode is entered simply by typing in a timecode value. So long as no clips or edit points are selected when you press the Return key, the playhead will move to that timecode value. If an edit point or clip is selected, those will be moved or trimmed to the corresponding timecode value, if possible.

Here are some examples of absolute timecode entry using this method:

<table>
<thead>
<tr>
<th>Original TC Value</th>
<th>User-Typed Value</th>
<th>New TC Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>01:10:10:10</td>
<td>15245218</td>
<td>15:24:52:18</td>
</tr>
<tr>
<td>01:10:10</td>
<td>2..</td>
<td>01:02:00:00</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>15</td>
<td>01:10:10:15</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>12</td>
<td>01:10:10:12</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>1.2</td>
<td>01:10:10:02</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>1115..</td>
<td>11:15:00:00</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>23...</td>
<td>23:00:00:00</td>
</tr>
</tbody>
</table>

Relative Timecode Entry

Relative timecode is entered by starting the timecode value with a plus (+) or minus (–). Adding a plus results in the value you type being added to the current timecode value for purposes of offsetting the playhead or moving a selection. Adding a minus will subtract the value you type from the current timecode value.
Here are two examples of relative timecode entry:

<table>
<thead>
<tr>
<th>User-Typed Value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>+20.</td>
<td>00:00:20:00 is added to the current timecode value.</td>
</tr>
<tr>
<td>+3..</td>
<td>00:03:00:00 is added to the current timecode value.</td>
</tr>
<tr>
<td>-5</td>
<td>00:00:00:05 is subtracted from the current timecode value.</td>
</tr>
</tbody>
</table>

**Copy and Paste Timecode in Viewer Timecode Fields**

You can right-click on most Viewer timecode fields in the Media, Edit, and Color pages to choose Copy and Paste commands from a contextual menu for copying and pasting timecode values. You can also click in the timecode fields and use the normal Copy (Command-C), and Paste (Command-V) keyboard commands. This works even between pages. The timecode value you’re pasting must be valid timecode, for example you can’t paste 0 hour timecode onto a 1 hour timeline.

**Gang Viewers (Playhead Ganging)**

Ordinarily, the playhead movement in the Source and Timeline Viewers is independent. However, if you click the Option menu at the upper right-hand corner of either Viewer and turn Gang Viewers on, the movement of the Source and Timeline Viewer playheads is locked together, so that they move in unison. This is useful when you’re marking the In and Out points of a clip in the Source Viewer to match the duration of a clip or other event in the Timeline.

When the Source and Timeline Viewers are ganged, you can still switch focus back and forth between the Source and Timeline Viewers, and your video output device will consistently switch to output whichever Viewer is in focus.

**Adding Markers**

While markers, flags, and clip labels are covered in much more detail elsewhere in the editing section, the use of markers is so important that a summary of how to add and edit markers appears here. Markers are used to call attention to a particular frame within a specific clip. Markers can be individually colored, and can have customized name and note text. Whenever you enter text into a marker, that marker displays a small dot that indicates there’s more information inside of it. Once placed, markers snap to In and Out points, edit points, the playhead, and other markers whenever snapping is enabled, making it easy to use markers to “measure” edits and trims that you make in the Timeline.
Adding Markers to Clips

You can place markers on the jog bar of source clips in the Source Viewer (or in the Media Page Viewer) and on clips that are selected within a timeline.

To mark a source clip in the Source Viewer or Media Page Viewer, do one of the following:

- To place a marker without doing anything else, move the playhead to the frame you want to mark, and then press M.
- To place a marker and immediately open the marker dialog to enter a name or note within it during playback, press Command-M. Playback pauses until you enter the text you want to and close the marker dialog again, at which point playback continues.
- Move the playhead to the frame you want to mark, then right-click in the jog bar and choose a marker color from the Add Marker submenu of the contextual menu.

Once you’ve added some markers, you may want to edit their contents to make them more useful.

To open a marker’s edit dialog to alter its properties:

1. Do one of the following:
   - Press Command-M to add a marker during playback and immediately open its edit dialog.
   - Double-click any marker you want to edit.
   - Move the playhead to the frame containing the marker you want to annotate using Shift-Up Arrow/Down Arrow and press M.
   - Select a marker anywhere in the Source Viewer or Timeline, and press Shift-M.

2. When the marker dialog opens, you can modify several properties.
Setting In and Out Points

Now that you’ve used playback commands to review your clips, you can place In and Out points to set the range of each clip that you want to edit into the Timeline. If you don’t set In or Out points, then the entire clip will be edited into the Timeline. If you do set In and Out points, those points will be saved in the Media Pool and used the next time you edit that clip.

Setting Clip In and Out Points in the Media Pool

You can set In and Out points right in the Media Pool to prepare for editing.

To set In and Out points while skimming a thumbnail in the Media Pool’s Metadata view:
– Set the Media Pool to Metadata view, then move the pointer over the Thumbnail and wait a moment until dragging the pointer begins to skim through that clip. As you skim, press I and O to set In and Out points to encompass the part of that clip you’re going to want to use.

To set In and Out points while skimming a thumbnail in the Media Pool’s Thumbnail view:
– Set the Media Pool to Thumbnail view, then move the pointer over a clip and wait a moment until dragging the pointer begins to skim through that clip. As you skim, press I and O to set In and Out points to encompass the part of that clip you’re going to want to use. When you’re finished, that clip’s thumbnail will show a range indicator at the bottom to show how much of the clip you’ve selected.

To set In and Out points using the Media Pool’s List view Filmstrip:
– Set the Media Pool to List view, then select a clip to expose it in the Filmstrip at the top of the Media Pool, drag the pointer through the Filmstrip to watch it play, and press I and O to set In and Out points to the appropriate range.

Marking In and Out points in the Filmstrip of the Media Pool in List view

The Filmstrip will dim the heads and tails to let you see the range of media you’ve marked. Once you’ve marked In and Out points in the Filmstrip, you can drag them to the left and right to move them.

Setting Clip In and Out Points in the Source Viewer

For a better look at your footage, you can set In and Out points in the Source Viewer in preparation for editing.

To set In and Out points in the Source Viewer:
1 Either skim a Media Pool thumbnail with Live Media Preview enabled in the Source Viewer’s option menu, or open a clip into the Source Viewer.
2 Use JKL, the Spacebar, the transport controls, or drag in the jog bar to move the playhead to where you want to set an In or Out point.

3 Do one of the following:
   - **To mark simple In and Out points**: Use the In and Out buttons to the right of the transport controls, or press the I or O keys.
   - **To mark split In and Out points in preparation for making a split edit**: Right-click the Jog Bar and choose Mark Split > Video In (Shift-Option-I) / Audio In (Command-Option-I) / Video Out (Shift-Option-O) / Audio Out (Command-Option-O).

Simple In and Out points let you join the audio and video of two clips at a single edit point in the Timeline. However, setting split In or Out points sets you up to create split edits where the video is offset from the audio in a single step.

**Clearing and Navigating In and Out Points**

Once placed, you can also clear In and Out points you don’t want and move the playhead to In and Out points you might want to edit.

**To clear In and Out points:**
   - **To clear In or Out points**: Move the pointer over a marked thumbnail in the Media Pool or over the Media Pool film strip, or open a clip in the Source Viewer, and then press Option-I to clear the current In point, or Option-O to clear the current Out point.
   - **To clear Split In or Split Out points**: Press Shift-Option-X to clear the Video In and Video Out points. Press Command-Option-X to clear Audio In and Audio Out points.
   - **To clear both the In and Out points at once**: With the pointer over a marked thumbnail in the Media Pool or over the Media Pool film strip, or with the Source Viewer selected, press Option-X.

**To jump the playhead to the current In or Out points in the Source or Timeline Viewer:**
   - Press Shift-I to move the playhead to the current In point (Playback > Go To > In).
   - Press Shift-O to move the playhead to the current Out point (Playback > Go To > Out).
The Go to In and Go to Out commands are capable of placing the playhead at the implicit (but unmarked) In and Out points defined by a three point edit you’re setting up, even when Preview Marks have not been enabled. For example, if you mark In and Out points in the Timeline, and you then mark an In point for a clip in the Source Viewer, pressing Shift-O (Go to Out) automatically moves the Source Viewer playhead to the frame that will be the Out point of that clip were you to execute this edit.

Clip Edit Points Are Saved

Once set, In and Out points remain in place within each source clip or timeline until you set new ones. If you quit DaVinci Resolve and later reopen the same project, each clip’s In and Out points are saved for future reference.

Turning In and Out Points into Markers With Duration and Back Again

If you want to log the most important sections of clips using In and Out points, you can only log a single section at a time, as In and Out points are used to identify the next section of a clip to be edited in a three point edit. However, two commands in the contextual menu of the Source Viewer jog bar work together to let you turn In and Out points into Markers with Duration, and vice versa:

- **Convert In and Out to Duration Marker:** Turns a pair of In and Out points into a duration marker. By default, no key shortcut is mapped to this command, but you can map one if you like.
- **Convert Duration Marker to In and Out:** Turns a duration marker into a pair of In and Out points, while retaining the marker. By default, no key shortcut is mapped to this command, but you can map one if you like.

Using these two commands, you can easily use markers with duration to mark regions of clips that you want to log for future use, turning each region into an In and Out point when necessary for editing. By default, these commands don’t have keyboard shortcuts assigned to them, but you can assign them if you use them frequently.
To turn In and Out points into a duration marker:

1. Set In and Out points in the Source Viewer jog bar to identify a region you want to log for future reference.

   ![Marking In and Out points in preparation to log that section of the clip](image1)

2. Do one of the following:
   - Right-click the jog bar and choose Convert In and Out to Duration Marker.
   - Choose Mark > Convert In and Out Into Duration Marker.

   A duration marker appears above the In and Out points. To edit its name or notes, double-click the marker, press Shift-M, or choose Mark > Modify Marker.

   ![A duration marker is created from the In and Out points](image2)

In this way, you can log several regions within a single clip for future use.

![A clip with multiple logged sections identified via markers with duration](image3)

To turn a duration marker into an In and Out point:

1. Find a duration marker you want to convert into In and Out points.

   ![Finding a duration marker to convert into In and Out points](image4)

2. Do one of the following:
   - Right-click the jog bar and choose Set In and Out from Duration Marker.
   - Position the playhead over the duration marker and choose Mark > Set In and Out from Duration Marker.

   In and Out points appear under the duration marker.

   ![In and Out points are created from the duration marker](image5)
In this way, you can turn a duration marker that you’ve logged into In and Out points in preparation for executing a three-point edit.

These are extremely useful logging techniques for three reasons. First, markers with duration can be searched for in the Media Pool using the All Fields, Marker Name, and Marker Notes Filter by options. Second, they can be filtered with Smart Bins using the Marker Name and Marker Notes Media Pool Properties options. Lastly, once one or more duration markers have been added to a clip, they can quickly be used to perform three-point edits into the Timeline.

Organizing Media by Creating Subclips

Subclips give you another way of organizing media in the Media Pool, letting you break excessively long clips into shorter ones. For example, if the director of a project is fond of “rolling takes” where multiple takes are all recorded within a single clip, you can break these takes up by making them into subclips.

To create a subclip in the Edit page:

1. Do one of the following to open a clip into the Source Viewer in either the Media page or the Edit page, in preparation for creating subclips.
   - Double-click any clip in the Media Pool.
   - Single-click any clip in the Media Library of the Media page to create a subclip without needing to first import that clip into the Media Pool.

2. Set In and Out points in the Source Viewer to define the section you want to turn into a subclip.

3. Do one of the following:
   - Choose Mark > Create Subclip.
   - Press Option-B.
   - Right-click the jog bar and choose Create Subclip from the contextual menu.
   - Drag a clip from the Source Viewer to the Media Pool.

A new subclip appears in the Media Pool, automatically selected so that you can immediately edit its metadata in the Metadata Editor.

Once created, subclips appear and work like any other clip in DaVinci Resolve. You can also create subclips in the Media page while performing other organizational tasks there.
In this chapter, you’ll learn many of the fundamental methods and commands you’ll use when beginning to assemble clips into the Timeline. This includes drag and drop operations to begin assembling a timeline, different ways of selecting and deselecting the clips you’ve edited in preparation for different tasks, maintaining sync between the audio and video components of clips you’re editing, and deleting clips and gaps you don’t want.

Contents

Keyboard Shortcuts in This Chapter 610
Drag and Drop Editing 611
Drag and Drop Editing of Individual Clips Into the Timeline 611
Drag and Drop Editing of Several Clips Into the Timeline At Once 612
Drag and Drop Editing of Video-Only or Audio-Only Edits 614
Drag and Drop Insert Editing 614
Dragging Clips From the File System Into the Timeline 615
Inserting Multiple Clips into the Timeline From the Media Pool 615
Insert Selected Clips to Timeline Using Timecode 615
Insert Selected Clips to Timeline With Handles 616
Audio Track Creation While Editing 616
Using Keyboard Shortcuts and Three-Point Editing to Assemble a Program 616
Example: Assembling Clips Into the Timeline From the Source Viewer 617
Example: Assembling Clips Into the Timeline From the Media Pool 618
Making Selections in the Timeline 619
Manually Selecting Clips in the Timeline 619
Selecting Clips Based on Markers, Flags, and Clip Color 620
Selecting Edits in the Timeline 621
A Practical Example of Keyboard-Driven Selections 622
Using Auto Select Controls to Define Selections 623
Defining Selections With the Help of Auto Select Controls 623
Overriding Automatic Selections by Making Manual Selections 624
Using Auto Select Controls to Control Other Operations 624
Locking Tracks You Don’t Want to Change 626
Position Lock for Finishing 627
Position Locking All Tracks 627
Position Locking Individual Tracks 627
Disabling and Re-Enabling Clips in the Timeline 628
Deleting Clips and Gaps From the Timeline 628
Finding, Selecting, and Deleting Gaps in the Timeline 630
Deleting Multiple Timeline Gaps at Once 631
Audio/Video Linking 632
Controlling Linked Selection 632
Linked Move Across Tracks 633
Dealing with Audio Video Sync Offsets 634
Manually Unlinking and Relinking Audio and Video 634
Linking Multiple Clips in the Timeline 635
Commands for Slipping Audio/Video Sync 636

Keyboard Shortcuts in This Chapter

Here’s a list of of keyboard shortcuts you might find helpful that relate to topics found in this chapter.

<table>
<thead>
<tr>
<th>Key Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>V</td>
<td>Select nearest edit to playhead</td>
</tr>
<tr>
<td>Shift-V</td>
<td>Select clip intersecting playhead</td>
</tr>
<tr>
<td>U</td>
<td>Select incoming, outgoing, or centered part of edit</td>
</tr>
<tr>
<td>Option-U</td>
<td>Toggle selection among video+audio, video only, and audio only</td>
</tr>
<tr>
<td>Option-Y</td>
<td>Select clips forward (of the playback) on all tracks</td>
</tr>
<tr>
<td>Command-Option-Y</td>
<td>Select clips backward (of the playback) on all tracks</td>
</tr>
<tr>
<td>Y</td>
<td>Select clips forward (of the playback) on current track</td>
</tr>
<tr>
<td>Command-Y</td>
<td>Select clips backward (of the playback) on current track</td>
</tr>
<tr>
<td>Up, Down Arrow Keys</td>
<td>Move selection to previous/next edit or clip</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete clip and leave gap (lift edit)</td>
</tr>
<tr>
<td>Forward Delete</td>
<td>Ripple delete; deletes a clip and moves the rest of the timeline left to fill the gap</td>
</tr>
<tr>
<td>Command-Backslash ()</td>
<td>Insert edit; adds a cut to the clip(s) at the position of the playhead</td>
</tr>
<tr>
<td>N</td>
<td>Toggle timeline snapping off and on</td>
</tr>
<tr>
<td>Command-Shift-L</td>
<td>Toggle linked selection off and on</td>
</tr>
<tr>
<td>Option-1 through 8</td>
<td>Set video destination control to that track number; press again to enable/disable</td>
</tr>
</tbody>
</table>
Drag and Drop Editing

If you’ve already used other editing programs, the procedures in this section will almost certainly be remedial, but if you’re new to editing, this section covers the most basic methods of editing a series of clips into the Timeline to get you started. The absolute simplest method of editing is to drag clips from the Media Pool and drop them into the Timeline. You can do this with individual clips, or with selected groups of clips.

Drag and Drop Editing of Individual Clips Into the Timeline

If you’re just editing one clip at a time to create an edited sequence in a timeline, this is how that works.

1. If you need to edit specific ranges of the clips you’re editing, you can set In and Out points in source clips first by doing one of the following:
   - **Setting In and Out points while skimming a thumbnail in the Metadata View:** As you’re skimming over a clip’s thumbnail in the Viewer, press I and O to set In and Out points to encompass the part of that clip you’re going to want to use. If you’ve turned on Live Media Preview in the Source Viewer, then the Source Viewer will show what you’re skimming so you can get a closer look. If you don’t like the current In and Out points, you can press Option-X to clear them both.
   - **Setting In and Out points while skimming a thumbnail in the Media Pool:** As you’re skimming over a clip’s thumbnail in the Viewer, press I and O to set In and Out points to encompass the part of that clip you’re going to want to use. If you’ve turned on Live Media Preview in the Source Viewer, then the Source Viewer will show what you’re skimming so you can get a closer look. When you’re finished, that clip’s thumbnail will show a range indicator at the bottom to show how much of the clip you’ve selected. If you don’t like the current In and Out points, you can press Option-X to clear them both.
– **Using the Media Pool Filmstrip in the Media Pool’s List view:** Set the Media Pool to List view, select Show Filmstrip in the option menu, then select a clip to expose it in the Filmstrip at the top of the Media Pool, drag the pointer through the Filmstrip to watch it play and press I and O to set In and Out points to the appropriate range. The Filmstrip will dim the heads and tails to let you see the range of media you’ve marked. If you’ve turned on Live Media Preview in the Source Viewer, then the Source Viewer will show what you’re skimming so you can get a closer look. If you don’t like the current In and Out points, you can press Option-X to clear them both.

– **Using the Source Viewer:** Open a clip in the Viewer by double-clicking it in the Media Pool, or by selecting it in the Media Pool and pressing the Return or Enter key. Then use the transport controls, jog bar, control panel buttons, Spacebar, or JKL commands to move the playhead, and place In and Out points using the In and Out buttons to the right of the transport controls, or by pressing the I or O keys. If you don’t like the current In and Out points, you can press Option-X to clear them both.

2 Drag the clip you want to edit from either the Media Pool or the Source Viewer, and drop it onto the desired position in the Timeline to perform an overwrite edit. If you drag a clip on top of another clip that’s already in the Timeline, the clip you’re dragging will overwrite the part of the clip that it overlaps.

![Dragging a clip from the Media Pool to overwrite a clip in the Timeline](image)

**TIP:** If you drag a clip into the blank area above an existing video track or below an existing audio track, a new track will automatically be created.

### Drag and Drop Editing of Several Clips Into the Timeline At Once

The procedure above also works when you want to edit several clips into the Timeline at once by dragging them from the Media Pool.

1 Change the sort order of the Media Pool’s browser area to put the clips into the order in which you want them to appear. In Thumbnail view you can use the Sort Order menu, but in List view you can click the header of any metadata column to sort by that column’s data. If you’ve used the Metadata Editor to add Scene, Shot, Take, or other information to identify each clip, you can sort by these metadata criteria.
Using the Sort Order menu to change the sort order of clips in the Media Pool

2 Use the Media Pool thumbnails, the Media Pool List view Filmstrip, or the Source Viewer to set In and Out points to define the part of each clip that you want to edit into the Timeline.

3 Select the Media Pool clips you want to edit into the Timeline by dragging a bounding box, Command-dragging multiple bounding boxes over different sets of clips, by Shift-clicking a range of clips, or by Command-clicking individual non-contiguous clips.

4 Drag any of the selected clips to the desired position in the Timeline to perform an overwrite edit.

The clip(s) you drag overwrite whatever other clips they overlap in the Timeline. Multiple clips dragged from the Media Pool will be edited in the order in which they’re sorted in the Media Pool, using each clip’s In and Out points.
Drag and Drop Editing of Video-Only or Audio-Only Edits

While it’s easy to edit just the video or just the audio of a clip by disabling the audio or video destination control in the Timeline prior to doing any sort of edit (described later in Chapter 40, “Three- and Four-Point Editing”), there’s also a pair of keyboard modifiers you can use to do the very same thing while you’re dragging.

- **To edit only the video of a clip from the Media Pool:** Option-drag clips from the Media Pool/Filmstrip, Source Viewer, or Finder into the Timeline.
- **To edit only the audio of a clip from the Media Pool:** Shift-drag clips from the Media Pool/Filmstrip, Source Viewer, or Finder into the Timeline.
- **To edit only the video or audio of a clip from the Source Viewer:** Open a clip into the Source Viewer, then move the pointer over the Source Viewer and drag from either the Video-only or Audio-only overlays that appear over the bottom of the image.

Drag and Drop Insert Editing

You can also drag multiple clips from the Timeline, or a single clip from the Source Viewer, at any frame of the current timeline to either insert the selection between any two clips or to insert it in the middle of an existing clip, moving (actually rippling) all media to the right of the new edit point you create to make room for the new incoming media.

**To shuffle insert multiple clips from the Media Pool or Source Viewer into the Timeline:**

1. Select one or more clips in the Media Pool (the sort order dictates the final order of the edited clips), or open a clip in the Source Viewer.
2. Press and hold the Command and Shift keys, and drag the selection from the Media Pool or Source Viewer into the Timeline.
3. As you drag, the clips you’re dragging will be inserted into the Timeline at the pointer location. Release the mouse to finish making the edit.
Dragging Clips From the File System Into the Timeline

You can also drag a clip directly from your file system to the Timeline on supported platforms.

Dragging multiple clips into the Timeline from the macOS Finder

Inserting Multiple Clips into the Timeline From the Media Pool

For certain large volume editing projects, you can insert multiple clips from the Media Pool into a timeline all at once. The parameters for the order and positioning of the clips depend on the method used.

Insert Selected Clips to Timeline Using Timecode

Clips can now be edited directly from the Media Pool into a timeline, such that each clip’s source timecode is aligned with an identical record timecode value in the Timeline. This can be useful for long form multi-camera events, like weddings or concerts, where all cameras are linked by the same timecode to ensure all edits are perfectly synced. This function matches the Source Overwrite edit on the Cut page.

IMPORTANT

The timecode of the Timeline must overlap the timecode of the clip(s) for this edit to function. This can be set in the Start Timecode field of the New Timeline settings.

To insert selected clips to timeline using timecode:

1. Select one or more clips to edit into the Timeline in the Media Pool. If there are In and Out points set on the clip, the edit will respect those boundaries. If no In/Out points are set, each selected clip’s full duration will be edited in its entirety.

2. Set a destination control to determine which track in the Timeline you want to edit to.
3 Right-click one of the selected clips and choose “Insert Selected Clips to Timeline Using Timecode” from the drop-down menu.

4 All of the selected clips will be overwritten into the Timeline at their appropriate timecode locations onto the destination track.

**IMPORTANT**

If multiple selected clips have overlapping timecode, no edit will occur.

**Insert Selected Clips to Timeline With Handles**

This command inserts multiple clips into the Timeline serially, using the current sort order of the Media Pool, with handles subtracted from the current In and Out points of each clip (using the Default Handles Length in the Editing panel of the User Preferences). Combined with the Add Transition tool (Command-T), this function is useful when quickly creating montages from multiple clips.

**To insert clips with handles to the Timeline:**

1 Select the clips to insert into the Timeline with handles in the Media Pool.

2 Right-click any selected clip, then choose “Insert Selected Clips to Timeline With Handles.” The clips will be inserted starting at the Timeline In point with the default handles length already calculated.

**TIP:** To finish creating the montage, select the clips in the Timeline, then choose “Add Transition” (Command-T) from the Timeline menu. This will apply the default transition to all of the clips at once.

**Audio Track Creation While Editing**

When dragging an audio clip to the undefined gray area of the Timeline below currently existing audio tracks in order to create a new track, the new track is set to a channel mapping that reflects the number of channels of the audio clip you’re dragging.

This also means that if you’ve used Clip Attributes to map a clip’s audio to consist of multiple tracks where each track has a different channel mapping, for example, one 5.1 track, one stereo track, and six mono tracks, then editing that clip into the Timeline so that the audio portion creates new tracks will automatically create eight tracks: one that’s 5.1, one that’s stereo, and six that are mono.

**Using Keyboard Shortcuts and Three-Point Editing to Assemble a Program**

While drag and drop editing is intuitive enough, there are other methods of editing clips into the Timeline by using the playhead to define where those clips will start that can be more efficient and precise. These examples all use “overwrite” edits, which delete unwanted media from the Timeline as you’re adding clips that you do want. Here are two examples of how to do this.
Example: Assembling Clips Into the Timeline
From the Source Viewer

The following example shows how you can use the Edit page to assemble a quick first cut of edits using different features of the Media Pool, Viewers, and Timeline. Written out with every possible option, this may seem like a lot of steps, but once you learn these fundamentals and develop some muscle memory for the keyboard shortcuts in use, these methods become really fast to do.

1 Press Command-1 to open the Bin list, and use the Arrow keys to select a bin (Up and Down to change the selection, Right and Left to open and close bins). Then press Command-2 to choose the clip browser, and use the Arrow keys to select a specific clip.

2 Press the Return or Enter key to open the selected clip into the Source Viewer.

3 Drag the playhead with the pointer or use the Spacebar or JKL keys to move the playhead and set In and Out points (I and O) to define the section of that clip you want to edit into your program.

4 By default, the destination controls are assigned to tracks V1 and A1. If necessary, choose different video and audio tracks to edit the clip to in the Timeline by doing one of the following:
   – Click the destination controls of the tracks you want to edit to. You can also drag them from where they are now to where you want them to be.
   – Use the Command-Option Up and Down Arrow (for audio) and Command-Shift Up and Down Arrow (for video) shortcuts to move the destination controls up and down.
   – Use the Option-1–8 (for video) and Command-Option-1–8 (for audio) key shortcuts to assign the video and audio destination controls to specific tracks.

5 By default, all destination controls are enabled. If you want to edit clips into the Timeline as audio or video only, you can do one of the following:
   – Click any destination control itself to disable the video or audio component.
   – Press Option-1–8 (for video) or Command-Option-1–8 (for audio) for the currently assigned tracks to toggle the destination controls on those tracks on and off.

6 In the Timeline Viewer or the Timeline itself, use the pointer, Spacebar, or JKL controls to move the Timeline playhead to the frame you want the beginning of the clip you’re about to edit to start. If no In or Out points are set in the Timeline, the playhead position is used as the In point by default.

7 To perform an overwrite edit, do one of the following:
   – Drag the clip from the Source Viewer to the Timeline Viewer and drop it on the Overwrite overlay. If you’re in single viewer mode, this overlay only appears when you drag a clip from the Media Pool to the Timeline Viewer.
   – Click the Overwrite Clip button in the toolbar.
   – Choose Edit > Overwrite (or press F10).
The selected clip(s) are overwritten to the selected track at the position of the playhead, and the playhead automatically moves to the end of the newly edited clip, ready for you to perform another edit. If that clip is the last one on the Timeline, you’ll see the last frame to the left of the playhead (with a jagged overlay at the right-hand side of the Timeline Viewer) instead of the black that is the actual frame after that clip. This makes it easier for you to line up the next edit. Otherwise, the playhead will show whatever frame happens to be at that point in time.

To edit another clip, open the next clip you want to edit into the Source Viewer, set In and Out points, and use the Overwrite Clip button or command to edit it into the Timeline. Continue this process until you’ve edited together the assembly of edits you want.

Example: Assembling Clips Into the Timeline From the Media Pool

If you want, you can also edit clips directly into the Timeline from the Media Pool using a variety of commands. This can be a fast way of appending clips to the end of the Timeline (although you can also perform insert edits this way).

To edit one or more clips from the Media Pool to the Timeline:

1. Press Command-2 or click with the pointer to choose a clip in the Media Pool.
2. Set In and Out points for one or more clips in the Media Pool by doing one of the following:
   - In Metadata view, drag the pointer over a clip’s thumbnail and use the I and O keys. If Live Media Preview is enabled in the Source Viewer, dragging over a clip’s thumbnail mirrors the content in the Source Viewer.
   - In Thumbnail view, drag the pointer over a clip’s thumbnail and use the I and O keys. If Live Media Preview is enabled in the Source Viewer, dragging over a clip’s thumbnail mirrors the content in the Source Viewer.
– In List view, drag over the Media Pool Filmstrip Viewer and use the I and O keys. If Live Media Preview is enabled in the Source Viewer, dragging over the filmstrip mirrors the content in the Source Viewer.

3 Change the sort order of the Media Pool’s browser area to put the clips into the order in which you want them to appear. In Thumbnail view you can use the Sort Order menu, but in List view you can click the header of any metadata column to sort by that column’s data.

4 Click, drag, use the Command-Option and Command-Shift Up and Down Arrow Key shortcuts, or use the Option-1–8 and Command-Option-1–8 key shortcuts to assign the video and audio destination controls to the tracks you want to edit the video and audio of the incoming clip(s) to. Click any destination control itself to disable it if you want to edit clips into the Timeline as audio or video only.

5 Select one or more clips you want to edit. Insert, overwrite, place on top, ripple overwrite, and append at end edits are all capable of editing multiple clips at once, while replace and fit to fill edits can only edit one clip at a time, and will only edit the first of multiple selected clips into the Timeline.

6 To perform the edit, do one of the following:
   – Use any of the editing commands in the Edit menu.
   – Use the equivalent keyboard shortcuts to Insert (F9), Overwrite (F10), Replace (F11), Place On Top (F12), Ripple Overwrite (Shift-F10), Fit to Fill (Shift-F11), or Append To End of Timeline (Shift-F12) the selected clips into the Timeline.
   – Right-click one or more selected clips in the Media Pool, and choose “Insert Selected Clips to Timeline” or “Append Selected Clips to Timeline.”

The selected clip(s) are edited into the Timeline.

Making Selections in the Timeline

Once you’ve assembled a sequence of clips in the Timeline, you’ll probably need to manipulate them further, moving, deleting, trimming, or otherwise adjusting the clips in the Timeline to make the edit play with the pacing and verve you require.

Manually Selecting Clips in the Timeline

Many operations require you to make a selection first, to define the scope of what you’re about to do. There are many ways to do so.

Selections you can make using the mouse:

– **To select one clip:** Click a clip with the mouse.

– **To select a continuous range of clips by dragging:** Drag a bounding box from an empty area of the Timeline to surround a group of clips.
To select a continuous range of clips by Shift-clicking: Click the first clip you want to select, and then Shift-click the last clip you want to select, and all clips in-between will automatically be selected as well.

To select a discontinuous range of clips: Command-click any clips to select them no matter where they appear on the Timeline. Command-clicking a selected clip deselects it.

Selecting clips using the keyboard or menu commands:

- To select one clip: Using the keyboard, make sure the Auto Select button for the track the clip is on is enabled, then move the playhead over that clip and press Shift-V.

- To select a clip using keyboard navigation: Holding down the Command key and pressing the Up, Down, Left, and Right Arrow keys allows you to select clips above and below the current track and to the left and right, independently of the playhead.

- To select all clips forward of the playhead on the current track: Move the playhead to the first clip you want to include in the selection, then press the Y key (Timeline > Select Clips Forward > On This Track) to select that clip and every clip to its right in the same track of the Timeline.

- To select all clips forward of the playhead on all tracks: Move the playhead to the first clip you want to include in the selection, then press Option-Y (Timeline > Select Clips Forward > On All Tracks) to select that clip and every clip to its right in all tracks of the Timeline.

- To select all clips backward from the playhead on the current track: Move the playhead to the last clip you want to include in the selection, then press Command-Y (Timeline > Select Clips Backward > On This Track) to select that clip and every clip to its left in the same track of the Timeline.

- To select all clips backward from the playhead on all tracks: Move the playhead to the last clip you want to include in the selection, then choose Command-Option-Y (Timeline > Select Clips Backward > On All Tracks) to select that clip and every clip to its left in all tracks of the Timeline.

- To select all clips in the Timeline: Make sure the Timeline has focus, then press Command-A.

To change which clip is selected using the keyboard:

- Select a clip, then use the Up Arrow and Down Arrow keys to change the selection to the previous or next clip among all tracks with Auto Select turned on.

Selecting Clips Based on Markers, Flags, and Clip Color

It’s also possible to select multiple clips that have a particular color of marker, flag, or clip coloration. This is useful in any situation where you’re using these organizational tools to keep track of clips with specific characteristics that you might need to later select for multi-clip operations.
For example, you might add purple markers to a series of audio clips that might need special EQ settings. Later, you can choose Timeline > Select Clips With Marker Color > Purple to select all of those clips in order to move them to another track, where you can apply the same EQ to all of them using an audio filter applied to the track. There are three ways of selecting groups of clips.

**To select groups of clips based on marker, flag, or clip color:**
- Choose Timeline > Select Clips With Flag Color > Blue – Cream
- Choose Timeline > Select Clips With Marker Color > Blue – Cream
- Choose Timeline > Select Clips With Clip Color > Orange – Chocolate

### Selecting Edits in the Timeline

A variety of editing and trimming methods require you to select an edit point, or part of an edit point, in order to resize, ripple, or roll an edit. You can do so using the mouse or using the keyboard.

**Methods for selecting edit points using the mouse:**
- **To select an edit to roll:** Move the mouse to the center of an edit point, and when the ripple cursor appears, click to select the edit.

![Selecting an edit point to roll](image1)

- **To select just the incoming or outgoing half of an edit point to resize or ripple:** Move the mouse to the left or right of the center of an edit, and when the resize/ripple cursor appears, click to select that portion of the edit.

![Selecting incoming or outgoing halves of an edit point to resize or ripple](image2)

**To select multiple edit points, do one of the following:**
- **To select multiple roll points:** Command-click the center of multiple edit points. Command-click a selected edit point to deselect it.

![Command-clicking the center of several edits to prepare to roll them all](image3)

- **To select multiple ripple points:** Command-click the left or right sides of multiple edit points.

![Command-clicking the left or right of several edits to ripple them all](image4)
To drag to select many edit points: Select the Trim tool (T), and drag a bounding-box over the edit points you want to select. You can press U to switch all selected edit points among rippling incoming edits, rippling outgoing edits, and rolling edits.

There is also a flexible set of keyboard shortcuts that makes it easy to select edit points in preparation for various operations if you like to avoid using the mouse.

**Keyboard shortcuts for selecting edits:**

- **V:** Selects the nearest edit point to the playhead on the lowest track with Auto Select enabled. Selects both the audio and video edit points of a clip together.
- **Option-E:** Selects the nearest video edit point to the playhead on the lowest track with Auto Select enabled. Linked audio edit points are not selected.
- **Shift-E:** Selects the nearest audio edit point to the playhead on the lowest track with Auto Select enabled. Linked video edit points are not selected.
- **U:** Once you’ve selected an edit point, this shortcut toggles among selecting the outgoing half, incoming half, or the entire edit.
- **Option-U:** Once you’ve selected an edit point, this shortcut toggles among selecting the video+audio of the edit, just the video, or just the audio.

**To move the selection to another edit:**

- Select a single edit point, then use the Up Arrow key (Previous Edit) or Down Arrow key (Next Edit) to change the selection to the previous or next edit point among all tracks with Auto Select turned on.

**To deselect all edit points:**

- **Using the mouse:** Click any empty area of the Timeline.
- **Using the keyboard:** Press Shift-Command-A.

**A Practical Example of Keyboard-Driven Selections**

Here’s an example of how you would use these keyboard shortcuts together as a sequence of operations.

**To select an edit point using the keyboard:**

1. Press Command-4 to give focus to the Timeline.
2. Move the Timeline playhead close to the edit point you want to select using the JKL keys.
3. Press the V key to select the nearest edit point to the playhead on the lowest track with Auto Select enabled. If there are overlapping superimposed clips on multiple tracks, turn off the Auto Select controls of tracks with edits you don’t want to select using Option-F1 through Option-F8 corresponding to the Auto Select controls on tracks 1–8. Using the mouse, you can solo a track’s Auto Select state by Option-clicking its Auto Select button. (Option-F9 toggles the Auto Select controls of all video tracks.)
4. Initially, the entire edit is selected, in preparation for a roll edit. To toggle among selecting the outgoing half, incoming half, and the entire edit, press the U key.
To toggle among selecting the video+audio of the edit, just the video, or just the audio, press Option-U.

Perform whatever operation you need to. When you're finished, using Up-Arrow or Down-Arrow to move the selection backward or forward in the Timeline, or press Command-Shift-A to deselect it.

Using Auto Select Controls to Define Selections

The Timeline Auto Select controls are extremely useful and versatile controls that serve many purposes. In short, they give you a way to specify which tracks will be affected or considered when you're performing an operation upon multiple superimposed clips on multiple tracks of the Timeline.

Also, the Timeline Auto Select controls are particularly convenient when you're using keyboard shortcuts to edit and you don't want to have to grab your mouse to explicitly select a single clip, since you can turn Auto Select on or off via keyboard shortcuts.

Defining Selections With the Help of Auto Select Controls

Here is the easiest example of when the Auto Select controls are indispensable. In the following example, there are two superimposed video clips and three superimposed audio clips. Supposing you only want to delete the media from tracks V2, V1, and A1, but you want to leave the media on A2 and A3 alone, you can turn off the Auto Select controls for tracks A2 and A3, and set Timeline In and Out points to define the range of the clips you want to delete. When you press the Delete key, only the media on the Auto Select-enabled tracks is deleted.

Before and After deleting a clip with Auto Select on Tracks A2, A3, and A4 turned off

TIP: If you set In and Out points to perform an operation and you don’t see any shading in the Timeline to indicate which parts of the Timeline will be affected and which won’t, chances are you have another selected clip in the Timeline somewhere you can’t see that’s overriding auto select. Press Command-Shift-A to de-select all and things should go back to normal.
Overriding Automatic Selections by Making Manual Selections

It’s important to note that manual selections that you make which highlight specific clips in the Timeline always override whatever the Auto Select control of a track is set to. In the following example, three clips are superimposed and the Auto Select control of every track except V2 has been turned off. Setting Timeline In and Out points now automatically defines that region of the clip on track V2 to be deleted were you to press the Delete key. You can see the affected part of the Timeline because it’s highlighted while the rest of the Timeline is dimmed.

Soloing the Auto Select control on track V2 to limit a Delete operation

However, if you clicked the clip on track V1 to select it manually, the automatic selection defined by the In and Out points disappears in favor of the highlighted clip you just clicked. This is because manual selections almost always take precedence over automatic selections you define using the In and Out points and Auto Select controls.

Making a manual selection overrides the Auto Select controls

This is good to keep in mind for situations where the fastest way to do the operation you need to do is to simply manually select the clip you want to define the operation.

Using Auto Select Controls to Control Other Operations

Other operations that are affected by the Auto Select controls include any command that uses “the clip on the lowest-numbered track with Auto Select enabled” to define what happens. This includes Copy and Paste, Mark Clip, Go To Next Edit/Previous Edit, the Selection Follows Playhead mode, Next Gap/Previous Gap, and so on (a full list of affected operations appears later).

A common example of when this is important is whenever you use the Mark Clip command to automatically set In and Out points to match the duration of a clip on the Timeline. If that clip happens to be at a section of the Timeline where there are multiple superimposed clips, each of which has a different duration, then by default the In and Out points (first and last frames) of the clip on the lowest numbered track is used to set Timeline In and Out points when you use Mark Clip.
Using Mark Clip with all Auto Select controls enabled, the clip on the lowest-numbered video track with Auto Select enabled defines the result.

However, if you disable the Auto Select control of track V1, then whichever clip is on the lowest video track with Auto Select still enabled is used as the target clip for the Mark Clip operation. In this example, the shorter clip on track V2 now sets the locations of the In and Out points.

Methods of enabling and disabling the Auto Select controls:

- **To toggle Auto Select for any track:** Click any track’s Auto Select control.
- **To toggle Auto Select for video tracks:** Press Option-F1 through F8 to toggle Auto Select on the corresponding tracks.
- **To toggle Auto Select for audio tracks:** Press Option-Command-F1 through F8 to toggle Auto Select on the corresponding tracks.
- **To toggle all video track Auto Select tracks off and on:** Press Option-F9.
- **To toggle all audio track Auto Select tracks off and on:** Press Option-Command-F9.
- **To “solo” Auto Select for a track and disable Auto Select on all other tracks:** Option-click any Auto Select control to leave that control on while turning off all other Auto Select controls of that type (video or audio).
- **To turn all audio or video Auto Select controls on and off:** Shift-click any video or audio Auto Select control to toggle on or off all Auto Select controls of that type (video or audio).

The following operations are affected by the state of each track’s Auto Select control:

- **Cutting, ripple cutting, copying, or deleting clips:** When using Timeline In and Out points to delete a range of media from the Timeline, only media on tracks with an enabled Auto Select control will be cut, copied, or deleted.
- **Deleting gaps:** When selecting and deleting gaps in the Timeline, clips on other tracks that overlap the selected gap will also be deleted on tracks with an enabled Auto Select control. Media to the right of affected tracks will ripple left to close the gap.
Selecting edit points using the keyboard: When you press V to select the nearest edit point, the edit point on the lowest track with Auto Select enabled is selected. When pressing the Up Arrow and Down Arrow keys to move the selection from edit point to edit point, edit points on tracks with a disabled Auto Select control are ignored.

Selecting clips using the keyboard: When a clip is selected, you can press the Up Arrow and Down Arrow keys to move the selection from clip to edit clip, but clips on tracks with a disabled Auto Select control are not seen by this operation.

Using Mark Clip: When using the Mark Clip command, clips on tracks with disabled Auto Select controls are ignored. This lets you choose a target clip to use for marking the clip when there are multiple overlapping superimposed clips.

Match Frame: When making a Match Frame operation, clips on tracks with disabled Auto Select controls are ignored. This lets you choose a target clip to use for matching a frame when there are multiple overlapping superimposed clips.

Rippling the Timeline during a trim operation: Tracks with Auto Select turned off will not be rippled. For more information on the rules of ripple trimming, see Chapter 44, “Trimming.”

Pasting clips: All copied clips will be pasted to the lowest numbered track with Source Control enabled. If all tracks of a particular type have their Auto Select controls turned off, then no clips of that type will be pasted at all.

Paste Insert: Tracks with Auto Select turned off will not be rippled or affected by clips being pasted via a Paste Insert command.

Using the insert or ripple overwrite edits: Only clips on tracks with Auto Select turned on will be rippled during an insert edit or ripple overwrite edit.

Finding gaps: When using Playback > Previous Gap (Command-Option-Semicolon) or Next Gap (Command-Option-Apostrophe), gaps on tracks with Auto Select disabled will be ignored.

Using Selection Follows Playhead: When you turn on “Selection Follows Playhead” so that the clip intersecting the position of the playhead is automatically selected. If multiple clips are intersecting the position of the playhead, the clip on the highest track will be selected. Clips on tracks with Auto Select disabled will not be selected.

Locking Tracks You Don’t Want to Change

Another step you can take to prepare before performing any kind of editorial operation is to lock tracks with media that you don’t want to be affected by whatever it is you’re about to do. For example, if you have a complex set of music edits on track A3 that you don’t want to be affected by operations that will ripple the Timeline, you can lock track A3 so those clips remain unaffected.

Tracks V2, V1, and A1 are unlocked, while tracks A2, A3, and A4 are locked

Clips on locked tracks cannot be moved, deleted, cut, or otherwise affected by editorial operations. Furthermore, parameters of locked clips cannot be edited in the Inspector. However, clips on locked tracks can be graded and otherwise modified in the Color page.
To toggle the lock or unlock state of tracks, do one of the following:

- Click any track’s lock control to toggle lock on and off.
- Shift-click any track’s lock control to toggle locking on and off for all tracks.
- Press Option-Shift-1 through 8 to lock or unlock tracks V1 through V8.
- Press Option-Shift-9 to lock or unlock all video tracks.
- Press Option-Shift-F1 through F8 to lock or unlock tracks A1 through A8.
- Press Option-Shift-F9 to lock or unlock all audio tracks.

Position Lock for Finishing

In a nutshell, turning position lock on prevents clips from being moved to the left or right, and it prevents all ripple operations. This is primarily useful when you’re near the end of post on a project for which the cut has been locked (or at least as “locked” as directors and producers allow any more), but you still need to make surgical changes that don’t risk throwing the video out of sync with audio that may be being edited and mixed elsewhere because of an accidentally rippled edit.

With position lock on, you can still make edits (such as Replace), slip clips, roll edits, add Resolve FX and other Open FX, and alter all manner of effects in the Inspector. You just can’t do anything that alters the position of clips in the Timeline, or ripples entire sections of the Timeline.

There are two ways you can enable Position Lock.

Position Locking All Tracks

You can turn Position Lock on and off for all tracks via a button in the toolbar above the Timeline.

![The Position Lock button on the toolbar](image)

When you turn position lock on, the Lock button of all tracks changes to show that position lock is enabled instead.

![Position lock indicated by each track’s Lock icon changing](image)

Position Locking Individual Tracks

You can also be extra tricky and enable position lock on a track-by-track basis by Command-clicking any track’s Lock button.
Position lock can be released by simply clicking that track’s Lock icon.

**Disabling and Re-Enabling Clips in the Timeline**

Sometimes there’s one or more video or audio clips in the Timeline that you don’t want to play along with the rest of the edited sequence, but you don’t want to remove from the Timeline either, in case you change your mind later. For this reason, it’s possible to Disable clips, effectively turning them off without removing them.

Disabled clips appear dimmed in the Timeline. They don’t play back, they’re not rendered, and they’re not output to video. However, their position is preserved in the Timeline, so you can always re-enable them at a later time if you change your mind and decide you want to use them.

**To disable or re-enable one or more selected clips:**

– Right-click part of the selection and choose Enable Clip from the contextual menu.
– Choose Clip > Enable Clip.
– Press D.

**Deleting Clips and Gaps From the Timeline**

There are two ways you can delete clips you don’t want in the Timeline. Using the Delete key, you can perform what’s sometimes called a “lift edit,” removing the unwanted clips and leaving a gap. Using the Forward Delete key, you can perform a “ripple delete,” removing unwanted clips and closing the gap by rippling the rest of the edited Timeline to the right of the deleted clip(s) by moving it to the left.
Deleting clips as a “lift edit” operation:

- **To remove one or more clips from the Timeline, leaving a gap**: Select a clip in the Timeline, or Shift-click or Command-click to select the clips you want to remove, and press the Delete key (or right-click the selection and choose Delete).

- **To remove a range of media from the Timeline on multiple tracks, leaving a gap**: Set Timeline In and Out points defining the range of media you want to delete, then turn off the Auto Select controls of any tracks with media you want to preserve, and press the Delete key (or right-click the selection and choose Delete).

Deleting clips as a “ripple delete” operation:

- **To delete one or more clips and close the gap by rippling the Timeline left**: Select a clip in the Timeline, or Shift-click or Command-click to select the clips you want to remove, and press the Forward Delete key.

- **To delete a range of media and close the gap by rippling the Timeline left**: Set Timeline In and Out points defining the range of media you want to delete, then turn off the Auto Select controls of any tracks with media you want to preserve, and press the Forward Delete key.
As with any ripple operation, all clips with In points to the right of the deleted range of media on tracks with auto select enabled are rippled to close the gap, and any clips with In points to the left of the In point of the affected range of media are unaffected.

Finding, Selecting, and Deleting Gaps in the Timeline

A gap is defined as a space between any two clips on the same track. Often gaps are desirable as they allow audio or video clips to be spaced apart from one another very specifically, but sometimes they’re not. If you want to find accidental gaps in your timeline that may be too small to see, a pair of commands lets you do this.

To move the playhead to the next gap on the Timeline:

1. Turn off the Auto Select controls of any tracks you want to omit from this operation.
2. Do one of the following:
   – Choose Playback > Previous Gap, or press Option-Command-Semicolon (;) to move the playhead to the next gap to the left of the playhead’s current position.
   – Choose Playback > Next Gap, or press Option-Command-Apostrophe (’) to move the playhead to the next gap to the right of the playhead’s current position.

To select or deselect a gap:

– Click once to select a gap, and click that gap again to deselect it.

You can only select one gap at a time. The principal reason to select a gap is to delete it, in the process rippling the Timeline to close the gap. In the following example, there’s a gap between two clips on track V1 that you’d like to close.

![Selecting a gap on track V1](image)

To delete a gap:

– Press the Delete key to close the gap. All clips to the right of it on tracks with Auto Select enabled will be rippled to the left to close the gap. Clips on tracks with Auto Select disabled will not ripple.

If you select a gap in a timeline with clips on multiple tracks, which clips will be deleted depends on the state of the Auto Select controls for each track in the Timeline.

– **All tracks with Auto Select enabled:** The range of media that overlaps the selected gap will also be deleted. Clips on those tracks will ripple left to fill the gap.

– **All tracks with Auto Select disabled:** The range of media that overlaps the selected gap will be left intact, and clips on those tracks will not ripple left, going out of sync with whichever clips do ripple.
Deleting Multiple Timeline Gaps at Once

You can also ripple-delete video and audio gaps in the Timeline all at once using the Edit > Delete Gaps command. This removes gaps among consecutive clips in the Timeline on all Auto Select enabled tracks. Each segment of the Timeline with a gap is rippled, in order to move clips that are to the right of each gap left to close that gap.

All gaps are defined for purposes of this command as empty spaces between clips that span all tracks in the Timeline. In the following example, various audio/video, audio-only, and video-only clips have gaps between them. Using Remove Gaps causes the Timeline to be rippled such that these clips abut one another as a continuous sequence, without any of them overlapping any others.

This is an extremely powerful and wide-ranging command. However, it's made safer by following strict rules in order to maintain overall A/V sync in timelines:

– Gaps will not be removed past the point where video and/or audio clips will overlap one another.
– Gaps will not be removed if they're under superimposed video clips that bridge the gap.
– Gaps will not be removed if one or more continuous audio clips bridge the gap.
– You can limit the range of the gaps to be deleted by setting In/Out points on the Timeline.
– If a linked set of video and audio items has a gap that includes an L or J split edit, it will be closed to the point that the audio or video, whichever extends the farthest, abuts the nearest clip to it.
Disabling a track’s Auto Select Control omits that track from consideration when following the above rules. This lets gaps on other tracks be closed so clips overlap those on the Auto Select-disabled track.

**WARNING**
Performing Remove Gaps with Auto Select disabled on one or more tracks could result in massive loss of video/audio sync if you’re not careful. To avoid this, Shift-click one video Auto Select control (or press Option-F9) and one audio Auto Select control (or press Command-Option-F9) to toggle all video and all audio Auto Select controls until they’re all turned on at once.

---

**Audio/Video Linking**

DaVinci Resolve gives you complete control over the linked relationship between the video and audio associated with a clip. By default, DaVinci Resolve tries its best to keep the video and audio of clips and timelines in sync. However, there are several ways you can suspend automatic syncing when you need to make a specific kind of edit.

**Controlling Linked Selection**

While selecting edits and clips, you can also choose whether the video and audio associated with a clip should be selected together (linked) or not. This determines whether operations performed to the video of a clip automatically affect the audio of the clip, and vice versa. In most instances, you'll probably want to leave Linked Selection turned on, so that selecting the video of a clip to move it elsewhere in the Timeline also results in the audio being selected and moved at the same time. Disabling A/V linking in this case could cause your video and audio to go out of sync undesirably.

However, there are plenty of instances when you’ll want to temporarily suspend this linked A/V relationship, such as when you want to create a split edit, where a clip’s audio In point is at a different frame than the video In point. In this case, you can suspend Linked Selection to select just the audio In point, then roll it either farther back or forward to create the split, without changing the In point of that clip’s video. When you’re finished, you can re-enable A/V linking.

At all times, the state of Linked Selection is visible via the Chain-link button at the right of the toolbar.

The Link Audio/Video button

---

**To turn Linked Selection off and on:**

– Click the Link Audio/Video button (or press Shift-Command-L).

**To temporarily suspend Linked Selection while making a selection:**

– Press the Option key while clicking a clip or edit point to select the video without selecting the audio, or vice versa.
Linked Move Across Tracks

The Timeline > Linked Move Across Tracks setting works in conjunction with Linked Selection to let you change how linked video and audio items move in the Timeline when you drag them up and down to reorganize clips from track to track. Depending on the task at hand, one or the other behaviors might be more convenient, but no matter how you have this mode set, video/audio sync is always maintained when you move clips left and right.

– **When Linked Move Across Tracks is enabled:** (On by default) Dragging one of a linked pair of video and audio items up or down in the Timeline moves the linked item up or down as well. So, moving a video clip from track V1 to V2 results in its linked audio clip moving from track A1 to A2 as well.

![Before and after with Linked Move Across Tracks enabled.; if video clip is moved, the linked audio clip moves simultaneously](image1)

– **When Linked Move Across Tracks is disabled:** Dragging one of a linked pair of video and audio items up or down to another track in the Timeline only moves that one item, other linked item(s) remain in the same track. So, moving a video clip from track V1 to V2 leaves the audio clip in track A1, where it was originally. This makes it easy to reorganize video clips into different tracks while leaving your audio clips organized the way they were, or vice versa. Keep in mind that in this mode, while you can move one item of a linked pair up and down freely, moving that item left or right results in all linked items moving by the same amount, so sync is maintained.

![Before and after with Linked Move Across Tracks disabled.; if the video clip is moved, the linked audio clip remains in its original position or vice versa](image2)
Dealing with Audio Video Sync Offsets

Audio/video sync is one of the most important things to maintain in any edited program. However, there are times when you may want to override the sync relationship of a clip’s audio and video to make a particular edit, so moving a clip’s audio and video out of sync is allowed.

If you disable Linked Selection and then move the audio or video of a clip independently of its linked video or audio counterpart, you’ll see red “out-of-sync” indicators at the left of each clip’s name bar, that displays the timecode offset by which the audio and video of that clip are out of sync. In the following example, the audio and video of a clip have been moved out of sync by Option-clicking the video and dragging it to the left.

![Sync markers on a clip with audio and video out of sync](image)

If you’ve moved the audio and video of a clip out of sync with one another, there’s a really easy way of getting them back into sync, by right-clicking the red out-of-sync indicator of any clip and choosing one of the available commands:

- **Slip into place**: Slips the content of the selected clip, without moving the clip, so that it’s in sync with the other items that are linked to that clip.
- **Move into place**: Moves the selected clip so that it’s in sync with the other items that are linked to that clip.
- **Slip others into place**: Slips the content of all other items that are linked to the selected clip, without moving them, so that all linked items are in sync.
- **Move others into place**: Moves all other items that are linked to the selected clip so that all linked items are in sync.

![Commands in the contextual menu of sync tooltips](image)

Manually Unlinking and Relinking Audio and Video

By default, clips that you import into DaVinci Resolve have their video and audio linked together, which makes it easy to maintain the relationship and sync of the audio and video components of a clip while you’re editing. However, there are many reasons you might want to override this automatic relationship, either breaking the A/V linking of a clip’s audio and video completely, or breaking it and relinking in a different way, or to different clips.
Methods of permanently changing audio/video linking in the Timeline:

- To unlink audio and video from one another: Select a clip, then right-click it and choose Link from the contextual menu (or press Option-Command-L). Unlinked clips do not appear with a chain icon before the clip name in the Timeline.

- To link audio and video clips to one another: Command-click an audio clip and a video clip so they’re both selected, then right-click the selected clips and choose Link from the contextual menu (or press Option-Command-L). A chain icon appears before the name of linked clips in the Timeline.

(Left) linked video and audio with a chain icon to the left of the clip name, (Right) unlinked audio and video items have no icon.

Linking Multiple Clips in the Timeline

You don’t just have to link audio and video clips that sync together, though. You can actually link any number of video and audio clips that you want to be able to select, move, and edit together as one, even if they were never originally meant to be synced. This makes linking an organizational mechanism as much as a sync management tool. Here are some examples of how you can use this:

- You can link a text generator with a subtitle to the clip it plays along with.
- You can link a sandwich of overlapping audio sound effects with the video clip they accompany.
- You can link off camera audio to an on camera shot.
- You can link the background and foreground clips of a green screen composite, with sound from both.

Linking multiple clips in the Timeline works the same as linking a single audio and video clip together; every single linked item appears with a chain icon to the left of the clip name, and suspending linked selection to force any single clip out of sync will result in the display of an “out-of-sync” indicator.
Commands for Slipping Audio/Video Sync

Another set of commands in the Trim > Slip Audio submenu let you slip the contents of one or more selected clips in order to alter the sync between the audio and video, either in whole frame increments, or in sub-frame increments if there are clips with marginal sync that you want to improve.

– One Frame Forward (Option-Period)
– One Frame Reverse (Option-Comma)
– One Subframe Forward (Option-Right Arrow)
– One Subframe Reverse (Option-Left Arrow)
Chapter 38

Using the Inspector in the Edit Page

The Inspector holds all the controls to modify, resize, retime and generally adjust anything related to a clip, transition, or effect on the Edit page Timeline.

Contents

Using the Inspector 638
Video 638
Audio 644
Effects 645
Transition 646
Image 647
File 648
Using the Inspector

The Inspector has been redesigned to make it easier to find specific controls and to adjust common settings for your clips. Instead of a long vertical list, different aspects of the Inspector have now been organized into panels, with each controlling specific grouped sets of parameters for your clip.

The Inspector is activated by clicking on the Inspector panel in the upper-right section of the User Interface toolbar. The Inspector is broken up into individual Video, Audio, Effects, Transition, Image, and File panels. Inspector panels that are not applicable to your clip or selection are grayed out.

Methods of using controls in the Inspector:

- **To activate or deactivate a control:** Click the toggle to the left of the control’s name. The orange dot on the right means the control is activated. A gray dot on the left means the control is deactivated.
- **To reveal a control's parameters:** Double-click the control's name.
- **To reset controls to their defaults:** Click the reset button to the right of the control's name.

Video

The Video panel of the Inspector exposes a vast array of controls designed to manipulate the size, speed, and opacity of your clips.

Transform

The Transform group includes the following parameters for resizing and repositioning your clips:

- **Zoom X and Y:** Allows you to blow the image up or shrink it down. The X and Y parameters can be linked to lock the aspect ratio of the image, or released to stretch or squeeze the image in one direction only.
- **Position X and Y:** Moves the image within the frame, allowing pan and scan adjustments to be made. X moves the image left or right, and Y moves the image up or down.
– **Rotation Angle:** Rotates the image around the anchor point.

– **Anchor Point X and Y:** Defines the coordinate on that clip about which all transforms are centered.

– **Pitch:** Rotates the image toward or away from the camera along an axis running through the center of the image, from left to right. Positive values push the top of the image away and bring the bottom of the image forward. Negative values bring the top of the image forward and push the bottom of the image away. Higher values stretch the image more extremely.

– **Yaw:** Rotates the image toward or away from the camera along an axis running through the center of the image from top to bottom. Positive values bring the left of the image forward and push the right of the image away. Negative values push the left of the image away and push the right of the image forward. Higher values stretch the image more extremely.

– **Flip Image:** Two buttons let you flip the image in different dimensions.
  – **Flip Horizontal control:** Reverses the image along the X-axis, left to right.
  – **Flip Vertical control:** Reverses the clip along the Y-axis, turning it upside down.

**Smart Reframe (Studio Only)**

The Smart Reframe feature makes it easier to quickly reframe material across extreme aspect ratio changes. It’s useful for situations where you’ve shot a 16:9 horizontal video and find yourself needing to create a vertically-oriented 9:16 version for mobile phones and social media deliverables, or using 4:3 archival footage in a 2.39:1 widescreen movie. Smart Reframe can be used manually, or automatically executed using the DaVinci Resolve Neural Engine.

– **Object of Interest:** Tools for selecting the subject that the resize will frame around.
  – **Auto:** DaVinci Resolve’s Neural Engine will analyze the clip and choose its most representative object. This will be the only option if more than one clip is selected for Smart Reframing.
  – **Reference Point:** Allows you to manually adjust a bounding box around the subject to reframe around.

– **Reframe:** This button executes the Smart Reframe command. This can take some time depending on the length and number of clips.

**Cropping**

The Cropping section of the Video Inspector panel
The Video Inspector controls the image’s cropping parameters.

- **Crop Left, Right, Top, and Bottom:** Lets you cut off, in pixels, the four sides of the image. Cropping a clip creates transparency so that whatever is underneath shows through.

- **Softness:** Lets you blur the edges of a crop. Setting this to a negative value softens the edges inside of the crop box, while setting this to a positive value softens the edges outside of the crop box.

- **Retain Image Position:** Clicking this checkbox will lock the crop parameters in place when you resize the image using the Transform tool above. Unchecking this box will scale and position the crop as well as the image.

### Dynamic Zoom

The Dynamic Zoom controls, which are off by default, make it fast and easy to do pan and scan effects to zoom into or out of a clip. Turning the Dynamic Zoom group on activates two controls in the Inspector that work hand-in-hand with the Dynamic Zoom onscreen adjustment controls. For more information on using the Dynamic Zoom controls, see Chapter 51, “Compositing and Transforms in the Timeline.”

- **Dynamic Zoom Ease:** Lets you choose how the motion created by these controls accelerates. You can choose from Linear, Ease In, Ease Out, and Ease In and Out.

- **Swap:** This button reverses the start and end transforms that create the dynamic zoom effect.

### Composite

Composite modes can be used to combine clips that are superimposed over other clips in the Timeline.

- **Composite Mode:** This selects the type of composite mode to combine the superimposed clips. The default “Normal” means no compositing mode is applied. For more information on Composite Modes, see Chapter 51, “Compositing and Transforms in the Timeline.”

- **Opacity:** This slider makes a clip more or less transparent in addition to compositing already being done.
Speed Change

You can change the speed of your clip directly in the Video Inspector’s Speed Change controls. This method has the benefit of being available in both Cut and Edit pages.

- **Direction**: Selects the desired motion of the clip, forward, backward, or freeze frame.
- **Speed %**: Adjusting this slider changes the clip’s motion on a percentage basis. This value can be keyframed.
- **Frames Per Second**: Adjusting this slider changes the clip’s motion by increasing or decreasing the number of frames per second to play the clip back at. This value can be keyframed.
- **Duration**: You can directly select how long you want the clip to be by setting a specific duration here in HH:MM:SS:FF format. This will then automatically adjust the speed of the clip to playback all frames in that exact amount of time.
- **Ripple Sequence checkbox**: If you want the speed change you’re about to make to ripple the Timeline, pushing or pulling all clips following the current one to accommodate the clip’s new size, then turn on this checkbox.
- **Pitch Correction checkbox**: Checking this box will perform pitch correction on the audio attached to the clip so that while the audio duration is changed to match the picture speed, it will still sound natural. Be aware that pitch correction on large speed adjustments may not sound as good as pitch corrections made to small speed adjustments.

Stabilization

These controls let you smooth out or even steady unwanted camera motion within a clip. The analysis is performed in such a way as to preserve the motion of individual subjects within the frame, as well as the overall direction of desirable camera motion, while correcting for unsteadiness.

These are the same stabilizer controls found in the Color page’s Tracker palette (minus the tracker graph), and the resulting stabilization analysis is mirrored on the Color page, where you can see the data visualized on the graph, if necessary.
A pop-up menu provides three different options that determine how the selected clip is analyzed and transformed during stabilization. You must choose an option first, before clicking the Stabilize button above, because the option you choose changes how the image analysis is performed. If you choose another option, you must click the Stabilize button again to reanalyze the clip.

- **Perspective**: Enables perspective, pan, tilt, zoom, and rotation analysis and stabilization.
- **Similarity**: Enables pan, tilt, zoom, and rotation analysis and stabilization, for instances where perspective analysis results in unwanted motion artifacts.
- **Translation**: Enables pan and tilt analysis and stabilization only, for instances where only X and Y stabilization gives you acceptable results.

The other controls let you customize how aggressively the selected clip is stabilized.

- **Stabilization Toggle**: The toggle control for the Stabilization controls lets you turn stabilization off and on to be able to compare the stabilized and unstabilized image.
- **Camera Lock**: Turning on this checkbox disables Cropping Ratio and Smooth, and enables the stabilizer to focus on eliminating all camera motion from the shot in an effort to create a locked shot.
- **Zoom**: When this checkbox is turned on, the image is resized by a large enough percentage to eliminate the blanking (black edges) that is the result of warping and transforming the image to eliminate unwanted camera motion. The lower a value Cropping Ratio is set to, the more DaVinci Resolve will need to zoom into an image to eliminate these blanked edges. If you turn this off, the image is not zoomed at all, and whatever blanking intrudes into the image is output along with the image, on the assumption that you’ll have dedicated compositing artists deal with eliminating this blanking by filling in the missing image data in a more sophisticated manner. You may also leave this checkbox turned off if you’re planning on animating the Input Sizing Zoom parameter to dynamically zoom into and out of a shot being stabilized to eliminate blanking only where it occurs, using only as much zooming as is necessary for each region of the shot.
- **Cropping Ratio**: This value limits how hard the stabilizer tries to stabilize, by dictating how much blanking or zooming you’re willing to accept in exchange for eliminating unwanted motion. A value of 1.0 results in no stabilization being applied. Progressively lower values enable more aggressive stabilization. Changing this value requires you to click the Stabilize button again to reanalyze the clip.
- **Smooth**: Lets you apply mathematical smoothing to the analyzed data used to stabilize the clip, allowing camera motion in the shot while eliminating unwanted jittering. Lower values perform less smoothing, allowing more of the character of the original camera motion to show through, while higher values smooth the shot more aggressively. Changing this value requires you to click the Stabilize button again to reanalyze the clip.
- **Strength**: This value is a multiplier that lets you choose how tightly you want to use the stabilization track to eliminate motion from a shot using the current analysis. With a value of 1, stabilization is maximized. Since some clips might look more natural with looser stabilization, choosing a number lower than 1 lets a percentage of the original camera motion show through. Zero (0) disables stabilization altogether. As an additional tip, you can invert the stabilization by choosing –1 when pasting a stabilization analysis from another clip to perform a match move based on the overall motion of the scene, and you can use a negative value either lower than 0 or higher than –1 to under or overcompensate when inverting the stabilization, simulating the effects of parallax where foreground and background planes move together but at different speeds.

**Lens Correction**

The Lens Correction section of the Video Inspector panel
The Lens Correction group (only available in Resolve Studio) has two controls that let you correct for lens distortion in the image, or add lens distortion of your own.

- **Analyze**: Automatically analyzes the frame in the Timeline at the position of the playhead for edges that are being distorted by wide angle lens. Clicking the Analyze button moves the Distortion slider to provide an automatic correction. If you’re analyzing a particularly challenging clip, a progress bar will appear to let you know how long this will take.

- **Distortion**: Dragging this slider to the right lets you manually apply a warp to the image that lets you straighten the bent areas of the picture that can be caused by wide angle lenses. If you clicked the Analyze button and the result was an overcorrection, then dragging this slider to the left lets you back off of the automatic adjustment until the image looks correct.

### Retime and Scaling

The Retime and Scaling section of the Video Inspector panel

The Retime and Scaling group has four parameters that affect retiming quality and clip scale:

- **Retime Process**: Lets you choose a default method of processing clips in mixed frame rate timelines and those with speed effects (fast forward or slow motion) applied to them, on a clip-by-clip basis. The default setting is “Project Settings,” so all speed-effected clips are treated the same way. There are three options: Nearest, Frame Blend, and Optical Flow, which are explained in more detail in the Speed Effect Processing section of Chapter 52, “Speed Effects.”

- **Motion estimation mode**: When using Optical Flow to process speed change effects or clips with a different frame rate than that of the Timeline, the Motion Estimation pop-up lets you choose the best-looking rendering option for a particular clip. Each method has different artifacts, and the highest quality option isn’t always the best choice for a particular clip. The default setting is “Project Settings,” so all speed-effected clips are treated the same way. There are several options. The “Standard Faster” and “Standard Better” settings are the same options that have been available in previous versions of DaVinci Resolve. They’re more processor efficient and yield good quality that are suitable for most situations. However, “Enhanced Faster” and “Enhanced Better” should yield superior results in nearly every case where the standard options exhibit artifacts, at the expense of being more computationally intensive, and thus slower on most systems. The Speed Warp setting is available for even higher-quality slow motion effects using the DaVinci Neural Engine. Your results with this setting will vary according to the content of the clip, but in ideal circumstances this will yield higher visual quality with fewer artifacts than even the Enhanced Better setting.

- **Scaling**: Lets you choose how clips that don’t match the current project resolution are handled on a clip-by-clip basis. The default setting is “Project Settings,” so that all mismatched clips use the same method of being automatically resized. However, you can also choose an individual method of automatic scaling for any clip. The options are Crop, Fit, Fill, and Stretch; for more information see the 2D Transforms section of Chapter 150, “Sizing and Image Stabilization.”

- **Resize Filter**: For clips that are being resized in any way, this setting lets you choose the filter method used to interpolate image pixels when resizing clips. Different settings work better for different kinds of resizing. There are four options:
  - **Sharper**: Usually provides the best quality in projects using clips that must be scaled up to fill a larger frame size, or scaled down to HD resolutions.
– **Smoother:** May provide higher quality for projects using clips that must be scaled down to fit an SD resolution frame size.

– **Bicubic:** While the Sharper and Smoother options are slightly higher quality, Bicubic is still an exceptionally good resizing filter and is less processor intensive than either of those options.

– **Bilinear:** A lower quality setting that is less processor intensive. Useful for previewing your work on a low-performance computer before rendering, when you can switch to one of the higher quality options.

– **Other Resize Methods:** A selection of specific resize algorithms is available if you need to match them to other VFX workflows.

### Audio

The Audio Inspector parameters

The Audio tab contains four commonly used audio controls for video editing purposes, including Clip Volume, Clip Pan, Clip Pitch, and Clip Equalizer.

– **Clip Volume:** Each clip has a single volume control that corresponds to the volume overlay over each audio clip.

– **Clip Pan:** (Only exposed for clips) A simple Pan slider that controls stereo panning.

– **Clip Pitch:** Lets you alter the pitch of a clip without changing the speed. Two sliders let you adjust clip pitch in semi tones (large adjustments, a twelfth of an octave) and cents (fine adjustments, 100th of an octave).

– **Clip Equalizer:** Each clip also has a four-band EQ, complete with low-pass, high-pass, and parametric settings for fine tuning and problem-solving audio issues at the clip level.
NOTE: There are many more refined plug-ins and effects for audio clips in the Audio FX library. If you apply any of these, the controls will appear in the Inspector’s Effects tab Audio section, instead of here.

Effects

Any Fusion FX, Open FX, or Audio FX filters that have been applied to a clip can be modified here in their respective tabs. Different effects in the Timeline expose different controls in the Effects panel. Whichever panels are exposed, parameters within each panel are organized into groups, with a title bar providing the name of that group, along with other controls that let you control all parameters within that group at the same time.

These controls include:

- **Enable button**: A toggle control to the left of the parameter group's name lets you disable and re-enable every parameter within that group at once. Orange means that track’s enabled. Gray is disabled.

- **Parameter group title bar**: Double-clicking the title bar of any group of parameters collapses or opens them. Even more exciting than that, Option-double-clicking the title bar of one parameter group collapses or opens all parameter groups at once.

- **Keyframe and Next/Previous Keyframe buttons**: This button lets you add or remove keyframes at the position of the playhead to or from every single parameter within the group. When the button is highlighted orange, a keyframe is at the current position of the playhead. When it’s dark gray, there is no keyframe. Left and right arrow buttons let you jump the playhead from keyframe to keyframe for further adjustment.

- **Reset button**: Lets you reset all parameters within that group to their default settings.

- **Use Alpha**: Checking this box applies the Open FX alpha channel to the selected clip, compositing it over any background elements that appear in lower tracks. If more than one alpha-modifying effect is applied to a single clip, the alpha channels are mixed together.

For a detailed explanation of each of the Resolve FX plug-ins that accompany DaVinci Resolve, see Part 12, “Resolve FX.”
Transition

Double-clicking a transition in the Timeline opens that Transition Panel in the Inspector. Each transition has the following properties you can edit.

- **Transition Type**: The currently selected transition. You can change to any other installed transition by selecting one in the drop-down menu.
- **Duration**: The duration of the transition, shown in both seconds and frames.
- **Alignment**: A drop-down that lets you choose the transition’s position relative to the edit point it’s applied to. Your choices are “Start on Edit,” “Center on Edit,” and “End on Edit.”

Additional properties that are specific to each type of transition appear in another group below. Since the Cross Dissolve transition is the most common transition used, its properties will be shown as an example.

- **Style**: The different Dissolve transitions (Cross Dissolve, Additive Dissolve, and so on) expose this drop-down that lets you choose different ways for the outgoing clip to blend into the incoming clip during the dissolve. There are six different options to choose from:
  - **Video**: A simple linear dissolve; the outgoing clip fades out as the incoming clip fades in.
  - **Film**: A logarithmic dissolve, simulating film dissolves as created by an optical printer.
  - **Additive**: The outgoing and incoming clips are cross faded using the Additive composite mode. As a result, the transition seems to brighten at the halfway point.
  - **Subtractive**: The outgoing and incoming clips are cross faded using the Subtractive composite mode. As a result, the transition seems to darken at the halfway point.
  - **Highlights**: The outgoing and incoming clips are cross faded using the Lighten composite mode. The lightest parts of each clip are emphasized during this transition.
  - **Shadows**: The outgoing and incoming clips are cross faded using the Darken composite mode. The darkest parts of each clip are emphasized during this transition.

- **Start Ratio**: Defines the percentage of completion for the transition at its first frame, from 0 to 100 percent. Setting the Start Ratio to anything but 0 results in the transition immediately appearing at a more fully cross-dissolved state from the very first frame.
- **End Ratio**: Defines the percentage of completion for the transition at its last frame. Setting the End Ratio to anything but 0 results in the transition never fully dissolving to the incoming shot at its last frame.
- **Reverse**: Reverses the transition. This parameter is disabled for Dissolve transitions.
– **Ease**: A drop-down that lets you apply nonlinear acceleration to the beginning, ending, or overall duration of a transition. The result is to add inertia to the transition from the outgoing clip to the incoming clip, providing a gentler change from each clip into and out of the transition.

– **None**: The outgoing clip fades away to the next shot in a linear fashion.

– **In**: The outgoing clip lingers as the beginning of the transition dissolves more slowly than the end.

– **Out**: The outgoing clip fades away more quickly as the beginning of the transition dissolves more quickly than the end.

– **In & Out**: Both the outgoing and incoming clips make slower transitions at the beginning and end of the dissolve, but the very center of the transition is faster as a result.

– **Custom**: Lets you modify the parameters of the fade manually using the Transition Curves below.

– **Transition Curve**: Allows you to manually set keyframes controlling the progress of the transition along its duration.

Other types of transitions display properties that are specific to that transition’s particular effect. For a detailed explanation of each of the transitions that accompany DaVinci Resolve, see Chapter 49, “Using Transitions.”

### Image

The **Image Inspector** controls for BRAW footage

The Image panel contains groups of parameters that correspond to every camera raw media format that’s supported by DaVinci Resolve. Using these parameters in the Image panel, you can override the original camera metadata that was written at the time of recording and make simultaneous adjustments to camera raw media throughout your project.

For a detailed explanation of each of the RAW camera parameters supported by DaVinci Resolve, see Chapter 6, “Camera Raw Settings.”
The File Inspector controls

The File panel of the Inspector provides a consolidated way to view and edit a subsection of a clip’s most commonly used media file metadata. It’s easily accessible in the Inspector across the Media, Cut, Edit, and Fairlight pages. The tab is composed of the following parts:

- **Clip Details**: Presents data about the clip’s data format (codec, resolution, frame rate, etc.).

- **Metadata**: Presents a reduced set of common metadata fields for quick user entry.
  
  - **Timecode**: The start timecode of the clip. This field is editable if you want to manually change the clip’s starting timecode.
  
  - **Date Created**: The date that the clip was created. This field is editable if you want to manually change the clip’s creation date.
  
  - **Camera**: Sets the Camera # metadata.
  
  - **Reel**: Sets the Reel/Card ID.
  
  - **Scene**: The Scene number of the clip.
  
  - **Shot**: The Shot letter/number of the clip.
  
  - **Take**: The Take number of the clip.
  
  - **Good Take**: This checkbox indicates if the clip is a good or circled take.
  
  - **Clip Color**: Assign a specific color to a clip that is reflected in the Timeline.
  
  - **Name**: This can be entered manually, and changes a clip’s name in that specific timeline only.
  
  - **Comments**: Add a text description to the clip.

- **Auto Select Next Unsorted Clip**: When this box is checked, the next clip in the Media Pool is selected when you hit the Return button after entering a metadata field, and the cursor is automatically placed in the same field. This allows rapid sequential metadata entry without having to manually click to load each individual clip in the Media Pool. The Next Clip button will select the next clip in the Media Pool, regardless of the checkbox status.
Chapter 39

Modifying Clips in the Timeline

Once you’ve edited a variety of clips into the Timeline, you’ll start working with them as you refine your edit. In this chapter, you’ll learn simple methods of modifying clips, including resizing, splitting, shuffling, disabling, copying and pasting, and duplicating.

Contents

Keyboard Shortcuts in This Chapter 650
Moving, Resizing, and Rolling Clips in Selection Mode 651
Trimming Gaps 654
Modifying Clip Duration Via Timecode 654
Resizing or Trimming Clips in the Source Viewer 655
Using the Selection Tool 655
Using the Trim Tool 655
Doing a Slip Edit in the Viewer 655
Shuffle/Swap Insert Edits 656
Splitting and Joining Clips 658
Through Edits 658
Enabling and Disabling Clips and Tracks 659
Copying and Pasting Clips in the Timeline 660
Paste Insert 661
Cut/Copy/Paste of Partial Clip Segments Using In and Out Points 661
Using the Cut/Copy Head and Tail Commands 661
Copying and Pasting Clips to a Different Track 662
Audio Channels When Copying and Pasting Audio Clips 662
**Keyboard Shortcuts in This Chapter**

Here's a list of keyboard shortcuts you might find helpful that relate to topics found in this chapter.

<table>
<thead>
<tr>
<th>Key Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Selection tool/mode</td>
</tr>
<tr>
<td>V</td>
<td>Select nearest edit to playhead</td>
</tr>
<tr>
<td>Shift-V</td>
<td>Select clip intersecting playhead</td>
</tr>
<tr>
<td>U</td>
<td>Select incoming, outgoing, or centered part of edit</td>
</tr>
<tr>
<td>Option-U</td>
<td>Toggle selection among video+audio, video only, and audio only</td>
</tr>
<tr>
<td>Up, Down Arrow Keys</td>
<td>Move selection to previous/next edit or clip</td>
</tr>
<tr>
<td>Comma, Period</td>
<td>“Nudge” keys to move a selected edit or clip left or right a frame at a time</td>
</tr>
<tr>
<td>Shift-Comma, Period</td>
<td>“Fast Nudge” keys to move a selected edit or clip left or right 5 frames at a time (customizable)</td>
</tr>
<tr>
<td>Shift-Left, Right Bracket ([, ])</td>
<td>Trim Start to Playhead and Trim End to Playhead to trim a clip at the position of the playhead</td>
</tr>
<tr>
<td>E</td>
<td>Extend edit to move a selected edit point to the playhead</td>
</tr>
<tr>
<td>B</td>
<td>Razor blade tool for adding cuts to clips using the pointer</td>
</tr>
<tr>
<td>Command-Backslash ()</td>
<td>Insert edit; adds a cut to the clip(s) at the position of the playhead</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete clip and leave gap (lift edit)</td>
</tr>
<tr>
<td>Forward Delete</td>
<td>Ripple delete; deletes a clip and moves the rest of the Timeline left to fill the gap</td>
</tr>
<tr>
<td>N</td>
<td>Toggle timeline snapping off and on</td>
</tr>
<tr>
<td>Command-Shift-L</td>
<td>Toggle linked selection off and on</td>
</tr>
<tr>
<td>Command-D</td>
<td>Change clip duration</td>
</tr>
<tr>
<td>Command-Shift (modifier)</td>
<td>While dragging, holding Command-Shift lets you “shuffle” or “swap” edit clips forward or backward to rearrange clips in the Timeline</td>
</tr>
<tr>
<td>D</td>
<td>Disable/Enable selected clips</td>
</tr>
<tr>
<td>Command-X</td>
<td>Cut selected clips, leave gap</td>
</tr>
<tr>
<td>Command-Shift-X</td>
<td>Ripple cut selection; close gap left by cut clip(s)</td>
</tr>
<tr>
<td>Command-C</td>
<td>Copy selected clips</td>
</tr>
<tr>
<td>Command-V</td>
<td>Paste clips</td>
</tr>
<tr>
<td>Command-Shift-V</td>
<td>Paste insert clips</td>
</tr>
</tbody>
</table>
Moving, Resizing, and Rolling Clips in Selection Mode

After editing a series of clips into a timeline, the next thing even the most careful of editors probably needs to do is to start making changes. The simplest changes are made in Selection Mode, using the regular arrow pointer.

This is the default mode when you open DaVinci Resolve, and allows you to move clips to other places in the Timeline, resize them to make them longer or shorter, and roll the edit points between two clips to move the edit to an earlier or later position on the Timeline. What this tool does depends entirely on what you click to select as you work.

Manipulating clips using the mouse:

1. Click the Selection Mode tool (the arrow), or press A.
2. Do one of the following:
   - To move clips in the Timeline: Drag any clip in the Timeline to any other position. If you drag a clip to overlap another clip, the clip you're dragging overwrites the clip you're dropping it onto.
   - To move clips in the Timeline up or down to other tracks while keeping them at the same time: Hold the Shift key down while dragging clips up or down in the Timeline. Or, you can hold the Option key down and press Up or Down Arrow.
Moving a clip into another track without sliding it in time by holding the Shift key down

- **To shorten or lengthen clips:** Move the Selection Mode pointer over the beginning or end of a clip, and when it turns into the Resize cursor, drag the In or Out point to the left or right to change the clip's length. As you do so, the audio will scrub along with the Resize cursor.

Resizing a clip in the Timeline to create a gap; a tooltip shows the offset, and outlines show you how much media is available in the clip being adjusted

- **To roll any edit:** Move the Selection Mode pointer over any edit point, and when it turns into the Roll Edit cursor, drag it to the left or right to move the edit point while simultaneously resizing the outgoing and incoming edits points of the two clips surrounding it. As you do so, the audio will scrub along with the right clip's In point.

Rolling an edit; a tooltip shows the offset, and an outline shows the available area you can roll within
Manipulating clips using the keyboard:

1. Press A to choose Selection Mode.

2. Do one of the following:
   - **To roll any edit incrementally:** Select the closest edit point to the playhead using the V key, moving the selection to another edit, if necessary, by using the Up Arrow and Down Arrow keys. Then press the Comma key (nudge 1 frame left) or Period key (nudge 1 frame right) to roll the selected edit to the left or right. Shift-Comma and Shift-Period nudges by 5 frames.
   - **To roll any edit using the playhead:** Select the closest edit point to the playhead using the V key, moving the selection to another edit, if necessary, by using the Up Arrow and Down Arrow keys. Then use the JKL keys to move the playhead to the frame you want to move the edit to, and press E to do an “extend” edit.
   - **To shorten or lengthen clips incrementally:** Select the closest edit point to the playhead using the V key, then use the U key to toggle the selection among the end of the outgoing clip and the beginning of the incoming clip. Then, press the Comma key (nudge 1 frame left) or Period key (nudge 1 frame right) to shorten or lengthen that side of the clip. If you nudge one end of a clip to overlap another, the clip you’re nudging overwrites the adjacent clip. Shift-Comma and Shift-Period nudges by 5 frames. In Selection mode, this either leaves a gap or overwrites neighboring clips.
   - **To shorten clips using the playhead:** Use the JKL keys to move the playhead over the frame in the Timeline where you want to set a new In or Out point for that clip, then press Shift-Left Bracket (]) to “trim start,” or Shift-Right Bracket ([]) to “trim end.” No selection is necessary. In Selection mode, this leaves a gap.
   - **To lengthen clips using the playhead:** Select the closest edit point to the playhead using the V key, then use the U key to toggle the selection among the end of the outgoing clip and the beginning of the incoming clip. Then, use the JKL keys to move the playhead to the frame to want to extend that edit point to, and press E to do an “extend” edit. In Selection mode, this overwrites neighboring clips.
   - **To move clips forward or back in the Timeline:** To select a clip in preparation for moving it, either click it, or use the Spacebar or JKL keys to move the playhead over it and press Shift-V. Then press the Comma key (nudge 1 frame left) or Period key (nudge 1 frame right) to move the clip to the left or right. If you nudge a clip to overlap another clip, the clip you’re nudging overwrites the adjacent clip. Shift-Comma and Shift-Period nudges by 5 frames. In Selection mode, this leaves a gap.
   - **To move clips up or down to other tracks:** To select a clip in preparation for moving it, either click it, or use the Spacebar or JKL keys to move the playhead over it and press Shift-V. Then, press Option-Up Arrow to move the Video and Audio of that clip to the next higher-numbered track, or press Option-Down Arrow to move the Video and Audio to the next lower-numbered track.

TIP: You can hold down the Shift key while nudging a selection to do a “fast nudge.” The duration of a fast nudge is customizable in the Editing panel of the User Preferences. By default it’s five frames, but you can set it to whatever you want.
Trimming Gaps

The start and end of gaps can also be rippled using the Trim tool. For more information, see Chapter 44, “Trimming.”

Modifying Clip Duration Via Timecode

You can change a clip’s duration numerically in one of two ways.

To change a selected clip’s duration:

1. Decide if you want to ripple the Timeline or overwrite neighboring clips when you change a clip’s duration. If you want to ripple the Timeline, choose the Trim tool. If you want to overwrite neighboring clips or leave a gap, choose the Selection tool.

2. Do one of the following:
   - Select a clip and choose Clip > Change Clip Duration.
   - Right-click any clip in the Timeline and choose Change Clip Duration from the contextual menu.

3. When the Edit Duration Change dialog appears, enter a new duration in the Timecode field, and click Change. For more information on timecode entry, see “Moving the Playhead Using Timecode” in Chapter 36, “Preparing Clips for Editing and Viewer Playback.”
Resizing or Trimming Clips in the Source Viewer

You can also open a clip from the Timeline into the Source Viewer to perform trimming in different ways. You can do this in one of two ways:

- Double-click a clip in the Timeline to open it into the Source Viewer.
- Move the playhead over a clip in the Timeline, press Shift-V to select that clip, and then press the Return or Enter key to open it into the Source Viewer.

Once you open a clip into the Source Viewer, the Source Viewer has focus, enabling you to use the Spacebar or JKL commands to move the playhead around in the Viewer in order to make edits. How these edits affect the Timeline depends on whether you use the Selection tool or the Trim tool.

**TIP:** To instead open a match frame of a clip in the Timeline using the pointer, hold the Option key down while double-clicking a clip.

### Using the Selection Tool

When the Selection tool is selected, you can drag the In and Out markers, or use the playhead and I and O keyboard shortcuts to resize that clip in the Timeline.

![Left: A Timeline clip opened in the Source Viewer, Right: resizing the clip and leaving a gap by dragging its In point in the Source Viewer](image)

### Using the Trim Tool

When the Trim tool is selected, dragging the In and Out points, or setting new ones using the I and O keys resizes the clip while rippling the Timeline left or right as necessary.

### Doing a Slip Edit in the Viewer

If you hold the Shift key down while dragging the In or Out point of a timeline clip you’ve opened in the Source Viewer, you’ll move both the In and Out points together, doing a slip edit of that clip’s content in the Timeline. This works using either the Selection or Edit tools.
Shuffle/Swap Insert Edits

A Shuffle Insert edit (sometimes referred to as a Swap Insert edit) lets you quickly rearrange one or more selected clips in the Timeline simply by Command-Shift dragging them to the left or right. When you do so, the surrounding clips automatically move to the right or left to switch places with the clip or clips that you’re dragging. This is a really fast way to reorder clips to try out different arrangements, without needing to drag clips onto multiple tracks to get them out of the way, first.

You have a lot of flexibility in how you shuffle clips around. You can select one clip, or multiple consecutive clips to shuffle. If you select multiple consecutive clips, they’ll move together as a single block. You can even select multiple consecutive clips on multiple tracks to shuffle around the Timeline as a single item.

Furthermore, you can also select clips that are part of split edits, where the audio and video In and Out points start or end at different frames. In this case, how other clips move in the Timeline to make room for the split edit clip you’re dragging depends on whether you click the video or audio portion of the clip to start dragging:

– If you click-and-drag the video portion of the clip, then all clips will rearrange themselves based on the duration of that video item on that track, so that all video items on that track rearrange themselves without either overwriting one another or leaving gaps. As you drag to shuffle the selection through the Timeline, overlapping linked audio items will either overwrite the audio on neighboring clips, or leave a gap.

– If you click-and-drag the audio portion of the clip, then all clips will rearrange themselves based on the duration of that audio item on that track, so that all audio items on that track rearrange themselves without either overwriting one another or leaving gaps. As you drag to shuffle the selection through the Timeline, overlapping linked video items will either overwrite the video on neighboring clips, or leave a gap.

Given the rules previously described, shuffling clips is really easy, and you can do so in one of two ways.

To shuffle insert clips with adjacent clips in the Timeline:

1. Turn snapping on.
2. Select one or more consecutive clips you want to shuffle.
3. Press and hold the Command and Shift keys down and drag either the video or audio portion of the selected clips to the left or right.

So long as you move clips to the In or Out points of adjacent clips, they’ll automatically switch places with the selection of clips you’re dragging. Snapping will help make sure that you align clip(s) you’re dragging with previously existing edit points until dropped in the desired location.
To shuffle insert one clip into adjacent clips in the Timeline:

1. Turn snapping off.
2. Select one or more consecutive clips in the Timeline that you want to shuffle.
3. Press and hold the Command and Shift keys down and drag either the video or audio portion of the selected clips to the left or right.

The selection of clips you’re dragging will be more easily inserted in the middle of adjacent clips as you drag with snapping turned off, and the cut portion of each clip will be moved into the gap that’s left behind by the clip(s) you’re dragging. Drop the clip into the desired location when you’re finished.

Before and after clip L being inserted into the middle of Clip K, which is split in half to make way for it

To shuffle insert multiple clips to another position in the Timeline:

1. Select all of the clips you want to move to another position on the Timeline.
2. Press and hold the Command and Shift keys, and drag the clips left or right. Make sure the item you click to drag is on the same track as the majority of clips you’re rearranging; the item you click defines which track is used to guide the rearrangement of clips.

In the following example, the video item of Clip C is selected on track V1, so as it’s dragged to the right, all clips on other tracks are rearranged according to the duration and location of clips B and C on track V1. As a result, clips on tracks other than V1 may be overwritten, or leave gaps, as necessary for the items on track V1 to be rearranged cleanly.
To shuffle insert multiple clips from the Media Pool or Source Viewer into the Timeline:

1. Either select one or more clips in the Media Pool or open a clip in the Source Viewer.
2. Press and hold the Command and Shift keys, and drag the selection from the Media Pool or Source Viewer into the Timeline.
3. As you drag, the clips you’re dragging will be inserted into the Timeline at the pointer location. Release the mouse to finish making the edit.

Splitting and Joining Clips

In many situations you may find yourself splitting clips (adding edits) in order to separate multiple clips that were inadvertently baked together, or to cut up clips into sections that you’re planning on applying different effects to or grading differently.

Methods of splitting and joining clips:

- **To split a clip once:** Drag the playhead to the frame where you want to split a clip, and press Command-Backslash (\) to split every clip on a track with Auto Select enabled.
- **To split many clips:** Click the Razor Edit mode button (or press B), and then click clips in the Timeline to split as many clips as you want.
- **To split clips using the DaVinci control panel on the Color page:** Move the playhead to the frame you want to split, then press SHIFT UP and SPLIT/UNDO on the T-bar panel.
- **To join clips using the DaVinci control panel on the Color page:** Move the playhead to the edit point you want to join, and press SHIFT UP and JOIN/REDO on the T-bar panel. Both clips must be from the same media file, and the frames to either side of the edit point need to be continuous for those clips to be joined.

**TIP:** Using the Blade Edit Mode or Split Clip command on a clip that’s currently selected preserves the selection on the first half of the clip after cutting.

Through Edits

When you split a clip, a through edit appears to show that you currently have an edit with continuous timecode running from the outgoing to the incoming half. This is called a through edit, and is displayed with a dotted line running along its edge so you know that it’s special.
To eliminate a through edit, do one of the following:

- Select it in the Timeline, and press Delete.
- Right-click a through edit in the Timeline, and choose Delete Through Edit.

**TIP:** You can show an isolated list of every through edit in the Timeline by opening the Edit Index and choosing "Show Through Edits" in the Edit Index Option menu. Clicking any item in the list jumps the playhead to that through edit, making it easy to check all the through edits in a timeline to see if they’re necessary or not.

### Enabling and Disabling Clips and Tracks

As you work in the Timeline, you’ll find there are times when you want to disable clips that you don’t want to appear during playback, without actually removing them from the edit. For example, you may decide to disable superimposed clips that are positioned as insert shots in the middle of a scene because of a client’s notes, but you don’t want to eliminate the clips because they might change their minds.

In another example, you’ve edited a series of titles on track V3, so you need to disable track V3 in its entirety to output a textless version of the movie as a deliverable.
When a clip or track is disabled, clips within it appear dimmed, and these disabled clips don’t appear in the Color page, and aren’t output to tape or rendered to disk in the Deliver page until that track is re-enabled first.

To disable/enable one or more clips in the Timeline:
- Select one or more clips, then right-click the selection and check or uncheck Enable Clip in the contextual menu, or press D to toggle a clip’s enabled state.

To disable/enable an entire track:
- Click the track enable button.

Copying and Pasting Clips in the Timeline

Clips can be cut, copied, and pasted in a variety of ways using standard keyboard shortcuts. You can cut or copy one clip or a selection of several, and you can also choose to copy or cut just the video or audio media of a clip. When pasting, you can paste to the same timeline, or to a different timeline if you want to move media from one to another.

Methods of doing simple cut, copy, and paste:
- **To cut one or more clips, leaving a gap:** Make a selection, and choose Edit > Cut (Command-X). The selected clip or clips are removed from the Timeline and stored in memory for pasting.

- **To ripple cut one or more clips and ripple the Timeline to close the gap:** Make a selection, and choose Edit > Ripple Cut (Command-Shift-X). The selected clip or clips are removed from the Timeline and stored in memory for pasting. All clips on tracks with Auto Select enabled will be ripples to the left to fill the gap left by the cut clips.

- **To copy one or more clips:** Make a selection, and choose Edit > Copy (Command-C). The selected clip or clips are left in the Timeline, but copies are stored in memory for pasting.

- **To paste one or more clips to the same track:** Move the playhead to the frame where you want the pasted selection to start, and then choose Edit > Paste (Command-V). By default, each copied clip is pasted onto the same track it was copied from. Pasted clips overwrite any clips in that track that are in the way. Pasted clips are automatically selected, ready for nudging left or right, or for other operations.

- **To paste one or more clips to a different track:** Pasting clips to a different track requires a slightly different procedure. Move the playhead to the frame where you want the pasted selection to start, then either Option-click any empty area on the track you want to paste the clip(s) to or Option-click the Auto Select control of that track to solo that track, and then choose Edit > Paste (Command-V). Pasted clips overwrite any clips in that track that are in the way. Pasted clips are automatically selected, ready for nudging left or right, or for other operations.
Paste Insert
Another paste command, Edit > Paste Insert (Command-Shift-V), lets you paste clips that you cut or copied via an insert edit, so that an edit is added at the position of the playhead to clips that are already in the Timeline, and all media to the right of the playhead is rippled farther right to make room for the clip or clips being pasted. As with all other ripple edits, only clips on tracks with their Auto Select control turned on are affected. Pasted clips are automatically selected, ready for nudging left or right, or for other operations.

Cut/Copy/Paste of Partial Clip Segments Using In and Out Points
You can use the Timeline’s In and Out points to cut and copy partial segments of longer clips in various ways. This is a valuable technique for doing in-depth audio and dialog editing, although it’s useful for copying partial segments of any kind of clip in the Timeline.

To cut or copy part of a clip to paste elsewhere:
1 Set In and Out points to isolate the part of the clip you want to cut or copy. You can use the Auto Select controls to include or omit clip segments on specific tracks while you do this.
2 Press Command-X to cut or Command-C to copy that clip segment.
3 Clear the In and Out points by pressing Option-X. Otherwise, you’ll paste the clip segment right back into the same place it started.
4 Move the playhead to the frame of the Timeline you want the pasted clip to start, and use the Paste or Paste Insert commands to paste the clip segment there. Pasted clips are automatically selected, ready for nudging left or right, or for other operations.

You can also use In and Out points to paste only a partial segment of a much longer clip that you’ve cut or copied.

To paste only part of a clip:
1 Select a clip, and press Command-X to cut or Command-C to copy that clip.
2 Set In and Out points to identify the region of the Timeline you want to paste into.
3 Use the Paste or Paste Insert commands to paste only as much of the Cut or Copied clip as will fit between the In and Out points you’ve placed. Pasted clips are automatically selected, ready for nudging left or right, or for other operations.

Using the Cut/Copy Head and Tail Commands
Four additional commands make it easy to cut or copy portions of one or more selected clips that intersect the playhead, either from the In point to the current position of the playhead (the Head), or from the current position of the playhead to the Out point (the Tail).

To cut or copy the head or tail of a clip:
1 Select the clip or clips you want to cut or copy the head or tail of in the Timeline.
2 Move the playhead so that it intersects the clip you want to cut or copy at the frame you want to define either the end of the head or the beginning of the tail.
3 Choose Edit > Cut/Copy Head/Tail to cut or copy the portion of the selected clip you want to paste.
4 You can now paste what you copied or cut using any of the previously described methods.
Copying and Pasting Clips to a Different Track

If all Auto Select controls on all tracks are turned on, clips are always pasted back to the same track they were copied from, starting at the position of the playhead. This is valuable for the many instances where you’ll find yourself copying and pasting clips you want to repeat, especially when doing audio editing.

However, if you want to paste the clips you cut or copied to a different track entirely, you need to use the Auto Select controls to specify which track you want to paste to.

Here are the rules:

– You can force paste what you copied to a specific track by Option-clicking that track’s Auto Select control to solo it before pasting.

– When one or more Auto Select controls are disabled, then clips are pasted to the lowest-numbered track with an enabled Auto Select control.

– If you’ve copied clips on multiple tracks, clips on the lowest copied track will be pasted to the lowest Auto Select enabled track, and all other clips will be pasted to higher tracks, with new tracks automatically created, if necessary.

– If Auto Select is disabled on every single track, then a new track will be created above all other video tracks and/or below all other audio tracks, and the clip will be pasted into this new track, which has Auto Select turned on.

Audio Channels When Copying and Pasting Audio Clips

Copying and pasting audio has one other consideration. If you’re force pasting a clip into a different track, the track you solo the Auto Select control of could possibly be set to an audio channel mapping that doesn’t match the clips you’re pasting there. An example of when this would happen is if you copy stereo audio clips from a stereo track and paste them to a mono audio track.

DaVinci Resolve allows you to do this, so you have the freedom of pasting audio clips to any track you want to. However, extra audio channels within clips that exceed the number of channels supported by the audio track they’re on will be muted. Fortunately, this situation is easy to rectify. Simply right-click the track header of the problem audio track, and use the Change Track Type To submenu to change its channel mapping to one more appropriate to the clips you’ve pasted into it.

Auto Align Clips

Auto Align Clips slides one or more selected clips to align with the timecode or audio waveforms of another clip that has matching timecode or audio. This function works for video clips, which can be aligned using timecode, and for audio clips, which can be aligned using either timecode or waveform matching. Waveform matching can also be used if you’re working with audio/video clips.

You can only select one clip per video or audio track to align, and they all will align to whichever clip is on the lowest-numbered video or audio track. Clips selected that have no overlapping timecode or audio waveform will not be moved and left in their original position on the Timeline.
For example, clip A on track V1 overlaps with clip B on track V2, but not with clip C on track V3, or clip D on track V4. Selecting all clips and using Auto Align Edits will slide clip B to align with clip A, but clips C and D won’t be moved because they don’t overlap with clip A.

The original Timeline with clip A (blue) and clip B (orange) that have some overlapping audio but are out of sync.

The same Timeline after the Auto Align command; clip B (orange) has been slipped to sync via audio waveform with clip A (blue). Clips C (tan) and D (green) were also selected, but because they had no overlapping timecode or audio, they remained in place.

In another example, clip A on track V1 overlaps with clips B, C, and D on tracks V2, V3, and V4 respectively. Selecting all clips and using Auto Align Edits will slide clips B, C, and D to be aligned with clip A.

The original Timeline with clip A (blue), and clip B (orange), C (tan), and D (green) all have overlapping audio, but are out of sync.
To use Auto Align clips:

1. Arrange the clips you want to align with one another on the Timeline so that there's one clip per track. All clips will sync to the clip on the lowest track number. All clips must have overlapping timecode or audio waveforms.

2. Select every clip that you want to align (only one per track).

3. Right-click one of the selected clips, and choose an option from the Auto Align Clips submenu, either “Based on Timecode,” or “Based on Waveform.”

If Timecode is selected, the operation will be instant. If Waveform is used, a progress bar will appear showing you how long it will take DaVinci Resolve to analyze the selected audio waveforms before your clips are aligned. If you’ve selected clips that can’t be aligned, a warning box will appear and tell you which clips had errors.

For video, this can be useful for multi-camera editing situations where you want to align an insert with the action of an alternate angle. For audio, this is useful for situations where you have multiple recordings of the same audio that you want to align for further editing.

NOTE: Waveform matching won’t work for re-recorded audio, such as dialog that’s been re-recorded using the ADR tools of the Fairlight page, as the correspondence between two waveforms must be precise for a match to be found.

Duplicating Clips and Transitions in the Timeline

One or more clips can be duplicated by making a selection, and then Option-dragging the selected clips to another position and/or track in the Timeline. When duplicating clips in this way, you must hold the Option key down until you release the mouse button.

Individual selected transitions can also be duplicated by Option-dragging them to another edit point.
Smart Reframe (Studio Only)

The Smart Reframe feature in DaVinci Resolve makes it easier to quickly reframe material across extreme aspect ratio changes. It’s useful for situations where you’ve shot a 16:9 horizontal video and find yourself needing to create a vertically-oriented 9:16 version for mobile phones and social media deliverables, or using 4:3 archival footage in a 2.39:1 widescreen movie. Smart Reframe can be used manually, or automatically executed using the DaVinci Resolve Neural Engine.

The Smart Reframe tool is found in the Sizing tab of the Inspector and is available in both the Cut and Edit pages.

To use the Smart Reframe tool:

1. Duplicate your timeline, right-click the Timeline and choose Timelines > Timeline Settings, and click Use Custom Settings to change the Timeline Resolution to the aspect ratio needed for delivery. Make sure that “Mismatched resolution files” is set to “Scale full frame with crop,” and click OK.

2. Select one or more clips you want to reframe, and open the Inspector to the Sizing tab.

3. Open the Smart Reframe controls, leave the Object of Interest drop-down menu set to Auto (if you’ve selected more than one clip, Auto is the only setting available), and click “Reframe.” DaVinci Resolve will analyze your footage and should automatically adjust each individual clip’s position to a more aesthetically pleasing framing.

4. (Optional) If the “Auto” setting does not give you desirable results for a particular clip, you can manually select the main subject using the following steps.
   a. To manually select the subject area, choose “Reference Point” from the Object of Interest drop-down menu, and click the target icon just to the right of the menu. This automatically sets the Viewer mode to Smart Reframe, exposing the onscreen controls for choosing a reference.
   b. Drag the Reference Point bounding box around the main subject of interest in the frame. You may use the Transform controls directly above in the Inspector to move the source clip around if your subject is outside the current framing.
   c. Click “Reframe.”
DaVinci Resolve locks onto and, if necessary, tracks your subject using the reference you’ve selected, automatically panning and scanning the original clip as needed to keep the reference within the new aspect ratio. While involving a bit of manual adjustment, this function still dramatically reduces the time involved in pan and scanning footage by manually adjusting and keyframing the sizing controls.

**Scene Cut Detection on the Timeline**

If you need to break down a previously edited video into its component clips for re-editing or color correction, you can do so directly in the Timeline. Using the DaVinci Neural Engine, DaVinci Resolve can automatically analyze and split up an edited video into individual clips.

Timeline Scene Cut Detection is also available in the Cut page. If you prefer, you can continue to use the original Scene Cut Detection tool found in the Media Pool.

**To use Scene Cut Detection on the Timeline:**

1. Select one or more clips you want to split on the Timeline. Alternately, you can limit Scene Cut Detection to just a portion of a clip by setting In and Out points on the Timeline around the section you want to analyze.

2. Choose Timeline > Detect Scene Cuts.

   A dialogue box appears, “Detecting scene cuts in clips x of x.” This process can take some time, depending on the length, number, and complexity of the clips you’ve selected. When the Scene Cut Detection has finished, the clip you selected will be broken up into a number of through edits that now can be used as independent clips.

**Checking and Fixing Your Results**

If the Neural Engine has made an error, you can fix it manually by navigating to the cut using the Up and Down Arrow keys to go back and forth in the Timeline, and by then doing one of the following:

- **To remove a Cut:** Click the through edit to select it, and press the “Delete” key.

- **To make a New Cut:** Place the timeline indicator at the cut point, and choose Timeline > Split Clips (Command-`).

A single clip of a finished edit, consisting of multiple cuts before the Detect Scene Cuts command

Multiple individual clips extracted from the edited clip via Detect Scene Cut; the operation has been contained by the In and Out points, and one of the resulting through edits has been highlighted in green.
Clean Up Video Tracks

While it’s convenient to be able to edit overlapping clips on multiple video tracks to try slipping clips back and forth, or to stack multiple takes or versions of a VFX clip, there comes a time when all those unnecessary clips take a toll on the visual organization of your timeline, not to mention your colorist’s sanity. For this reason, a trio of commands for cleaning up your timeline have been added to the Timeline > Clean Up Video Tracks menu. These are:

– **Flatten Unused Clips**: All superimposed clips with In and Out points that are aligned with clips below them are moved down to track V1, so long as they don’t have any kind of opacity, composite mode, transition, or fade effect applied to them making them a compositing effect.

– **Disable Unused Clips**: All clips that are underneath superimposed clips that don’t have any kind of opacity, composite mode, transition, or fade effect applied to them are disabled.

– **Change Unused Clips Color**: All clips that are underneath superimposed clips that don’t have any kind of opacity, composite mode, transition, or fade effect applied to them have their color changed to whatever you select.

(Top) The original timeline. (Bottom) The Flatten Unused Clips command is used to move superimposed clips with In and Out points that match other clips underneath them to track V1 to simplify the Timeline for future work.
A more controlled form of editing is to use three- and four-point editing to make a specific range of source media fit into a specific range of the Timeline. This chapter covers the basics of three- and four-point editing, as well as the wide variety of edit commands that are available.

Contents

Keyboard Shortcuts in This Chapter 669
Introduction to Three-Point Editing 670
Choosing a Track to Edit to Using Destination Controls 670
Setting In and Out Points in the Timeline 671
Mark Clip and Mark Current Selection 673
Preview Marks During Three-Point Editing 674
Dragging Preview Marks to Change an Edit 675
The Rules of Three-Point Editing 676
Editing Rules for Split In and Out Points 678
Editing a Specific Range of the Source Clip Into the Timeline 678
Editing Part of a Source Clip to Fit Into a Specific Range of the Timeline 679
Backtiming a Source Clip When Editing Into the Timeline 680
Switch Focus to Timeline After Edit 681
Different Types of Three- and Four-Point Edits 682
Overwrite Edits 682
Insert Edits 683
Replace Edits 684
Fit to Fill 687
Place on Top 688
Ripple Overwrite 689
Keyboard Shortcuts in This Chapter

Here’s a list of keyboard shortcuts you might find helpful that relate to topics found in this chapter.

<table>
<thead>
<tr>
<th>Key Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command-1</td>
<td>Choose Media Pool Bin list</td>
</tr>
<tr>
<td>Command-2</td>
<td>Choose Media Pool browser area</td>
</tr>
<tr>
<td>Arrow Keys</td>
<td>Move selection in the Media Pool Bin list or browser area to choose a bin or clip</td>
</tr>
<tr>
<td>Return or Enter</td>
<td>Open selected clip or timeline into the Source Viewer</td>
</tr>
<tr>
<td>Q</td>
<td>Toggle focus between Source and Timeline Viewers</td>
</tr>
<tr>
<td>I, O</td>
<td>Set In or Out point</td>
</tr>
<tr>
<td>Shift-I, O</td>
<td>Move playhead to In or Out point</td>
</tr>
<tr>
<td>Option-I, O</td>
<td>Delete In or Out point</td>
</tr>
<tr>
<td>Shift-A</td>
<td>Set In and Out points to match the current clip selection in the Timeline</td>
</tr>
<tr>
<td>X</td>
<td>Set In and Out points to fit the current clip at playhead in the Timeline</td>
</tr>
<tr>
<td>Option-X</td>
<td>Delete both In and Out points</td>
</tr>
<tr>
<td>Command-Shift-Up, Down Arrow</td>
<td>Move video destination control up or down to another track</td>
</tr>
<tr>
<td>Command-Option-Up, Down Arrow</td>
<td>Move audio destination control up or down to another track</td>
</tr>
<tr>
<td>Option-1 through 8</td>
<td>Set video destination control to that track number; press again to enable/disable</td>
</tr>
<tr>
<td>Command-Option-1 through 8</td>
<td>Set audio destination control to that track number; press again to enable/disable</td>
</tr>
<tr>
<td>Option-F1 through F8</td>
<td>Toggle video auto-select for that track number</td>
</tr>
<tr>
<td>Option-F9</td>
<td>Toggle all video auto-select controls off or on</td>
</tr>
<tr>
<td>Option-Command-F1 through F8</td>
<td>Toggle audio auto-select for that track number</td>
</tr>
<tr>
<td>Option-Command-F9</td>
<td>Toggle all audio auto-select controls off or on</td>
</tr>
<tr>
<td>Option-Shift-Q</td>
<td>Toggles “Switch to timeline after edit,” to set whether focus stays on the Source Viewer or switches to the Timeline after you make an edit; on by default</td>
</tr>
<tr>
<td>F9</td>
<td>Insert Edit selected clip(s) from Media Pool or Source Viewer to the Timeline</td>
</tr>
</tbody>
</table>
Introduction to Three-Point Editing

Three-point editing is a standard editorial method that’s shared with many other post-production applications, so this procedure should feel familiar. The idea is that you need only set any combination of three In and Out points in the source clip and Timeline to edit a clip into your program at a specific time, and DaVinci Resolve automatically figures out the fourth edit point that’s necessary to execute the edit. Three-point editing is most commonly accomplished using overwrite and insert edits.

Choosing a Track to Edit to Using Destination Controls

The orange destination controls, found in the Timeline header area, let you specify which video and audio tracks you want incoming source clips to be edited to when you use editing methods other than drag and drop. No matter how many video or audio channels may be embedded within a single clip of media, only one video and one audio destination control is available. In the case of video, you can only expose one video channel of a clip at a time. In the case of audio, all audio channels for a given clip are embedded within a single Timeline track, making it a snap to edit stereo or other multi-channel audio sources together. For more information about working with audio, see Chapter 45, “Working with Audio in the Edit Page.”

Setting the destination control of a track is a vital step in the process of creating an edit, and is easy to do. You can set the video and audio destination controls to be separate tracks.

To assign the destination tracks of incoming source clips, do one of the following:

- Click the destination control of any unassigned track to enable that track as the destination.
- Drag the destination control to any unassigned track in the Timeline.
- Press Command-Shift Up Arrow and Down Arrow to move the Video destination control up and down among different video tracks, or press Command-Option Up Arrow and Down Arrow to move the Audio destination control up and down among different audio tracks.
- Press Option-1 through 8 to set a video destination, or press Option-Command-1 through 8 to set an audio destination on tracks 1 through 8.
You can also disable the Video or Audio destination controls in situations where you want to edit a source video clip into the Timeline without its audio, or vice versa.

**To disable or reenable a destination control, do one of the following:**

– Click an already assigned destination control to toggle it off and then on again.

– Pressing the “assign destination control” repeatedly for a given track (Option 1-8 for video, Option-Command-1-8 for audio) toggles the destination track on and off.

Disabled destination controls are highlighted gray.

### Setting In and Out Points in the Timeline

When you’re setting up an edit to the Timeline, you can oftentimes get away with simply putting the Timeline playhead at the frame where you want to edit the incoming source clip. In the absence of In or Out points, the playhead is used as the In point. However, you can set up different kinds of edits by setting specific In and Out points to define different ranges of the Timeline.

**Methods of setting and clearing In and Out points in the Timeline:**

– **To set an In or Out point:** Select the Timeline or Timeline Viewer by clicking or pressing the Q key, then use the transport controls, jog bar, or control panel buttons to move the playhead, and press the I key to set an in point, or the O key to set an Out point.

– **To clear In or Out points:** With the Timeline Viewer selected, press Option-I to clear the current In point, or Option-O to clear the current Out point.

– **To clear both the In and Out points at once:** Press Option-X.
Methods of moving In and Out points in the Timeline:

- Move the playhead, and then press the I or O keys to change the In or Out points to the new position of the playhead.
- Drag any In or Out point in the Timeline ruler to another position.

The area of the Timeline outside the region that’s currently defined by In and Out points is dimmed, to call attention to the portion of the Timeline that will be affected by the next edit you’ll make.

To move the playhead to an In or Out point in preparation for making an adjustment:

- Press Shift-I to immediately move the playhead to the current In point, or Shift-O to move the playhead to the current Out point.

The Go to In and Go to Out commands are capable of placing the playhead at the implicit (but unmarked) In and Out points defined by a three point edit you’re setting up, even when Preview Marks have not been enabled. For example, if you mark In and Out points in the Timeline, and you then mark an In point for a clip in the Source Viewer, pressing Shift-O (Go to Out) automatically moves the Source Viewer playhead to the frame that will be the Out point of that clip were you to execute this edit.
Mark Clip and Mark Current Selection

These commands are automatic ways of setting In and Out points in the Timeline both at once, using the timing of other clips. They’re both exceptionally handy for defining the range of an incoming edit using clips that are already in the Timeline that you want to replace, or gaps in the Timeline that you want to fill.

In short, Mark Clip uses the first and last frame of a target clip or gap in the Timeline to automatically set Timeline In and Out points for editing. For example, if there’s a shot in an edit that you want to replace with a different take of the same action, or there’s a gap in a sequence of clips that you’d like to quickly fill with B-roll, you can use the Mark Clip command to help set this up.

Mark Current Selection uses the first and last frames of a range of selected clips to automatically set Timeline In and Out points for editing. A good example is when you have a series of clips in the Timeline, all of which you’d like to overwrite with a single incoming source clip, you can use the Mark Current Selection command.

To use Mark Clip:

1. Move the playhead to intersect either a clip you want to use to set In and Out points, or a gap (empty area) between two other clips that you want to target. The playhead can be on any frame of this clip, it doesn’t matter which.

2. If there are other clips on a multi-track timeline that overlap the clip you’re targeting for this operation, then the clip on the lowest video track will be used as the target to set the In and Out points. If you want to target a clip on a higher track, then either disable the Auto Selection controls of all timelines underneath, or Option-click the Auto Selection control of the track with the clip you’re targeting to solo it, which will force that track to be the target of this operation.

3. Press the X key to automatically set In and Out points that match the first and last frames of the target clip.

Using Mark Clip to set In and Out points that match a clip’s duration
**TIP:** To clear both In and Out points, press Option-X, which is the opposite of this command.

**To use Mark Selection:**

1. Select one or more clips in the Timeline.

Selecting clips you want to use as a range to mark In and Out points

2. Press Shift-A to automatically set In and Out points that match the first and last frames of the selection. A range of discontinuous clips will produce the same result as a range of continuous clips.

Marking a selection to set In and Out points

**Preview Marks During Three-Point Editing**

In order to help you see what will happen whenever you execute a three-point edit, preview marks appear in either the Source Viewer or the Timeline Ruler to let you know the exact duration of the Timeline that’s about to be affected by the edit you’re preparing to make. To prevent them from being a distraction, preview marks only appear once you’ve explicitly marked three edit points in the Source Viewer and Timeline, and they can be turned on and off by choosing View > Show Preview Marks.

For example, if you set In and Out points in the Source Viewer, and an In point in the Timeline, then a preview marker will appear in the Timeline Ruler to show the implied Out point in the Timeline of the edit you’re about to make.
A preview marker in the Timeline shows the Timeline Out point being automatically calculated by DaVinci Resolve based on the In and Out points that are set in the Viewer, and the In point in the Timeline.

On the other hand, if you set both In and Out points in the Timeline, and only an Out point in the Source Viewer, a preview marker appears in the jog bar of the Source Viewer to show you the implied In point, in the Source Viewer, of the edit you’re about to make.

A preview marker in the Source Viewer shows the Source Viewer In point being automatically calculated by DaVinci Resolve based on the In and Out points that are set in the Timeline, and the In point in the Source Viewer.

If you like, you can move the playhead to the position of the preview mark by using Shift-I if the preview mark is an In point, or Shift-O if the preview marker is an Out point.

**Dragging Preview Marks to Change an Edit**

You can drag preview marks to alter the edit you’re about to make. When you drag a preview mark, the corresponding In or Out point that’s opposite the Viewer with focus is altered to accommodate the new three-point edit you’re setting up. For example, if you have an In point in the Source Viewer, and In and Out points set in the Timeline, a preview mark appears in the Source Viewer to show the Out point that will be used to edit the clip in the Source Viewer into the Timeline. However, you can drag this preview mark to the left in the Source Viewer, and the result will be that the Out point in the Timeline will move along with it, since you’re retiming the edit.
The Rules of Three-Point Editing

In the previous examples, three-point editing was being used by virtue of source In and Out points being set to define a range of the source clip to be edited into the Timeline, and the Timeline playhead being used as the acting Timeline In point; three points defined the edit to be made. However, three-point editing is also very useful when you need to overwrite sections of a previously edited timeline with new source clips in a controlled manner, such as when adding an insert shot to a scene to cover a particular change you’re making that would break continuity.

Depending on the combination of Source and Timeline In and Out points you set, the following rules govern three-point editing:

- **If there is no In point in the source clip:** The first frame of media will be used as the acting source In point. This can be seen by the thick bar that extends to the left of the Out point in the Source Viewer’s jog bar.
– If there is no Out point in the source clip: The last frame of media will be used as the acting source Out point. This can be seen by the thick bar that extends to the right of the In point in the Source Viewer’s jog bar.

![A thick bar indicates which part of the source clip will be used in the absence of a Source Out point.](image)

– If there are no In or Out points in the Timeline: The playhead will be used as the acting Timeline In point.

– If you set a Timeline In point but no Timeline Out point: The whole range from the In to Out points of the source clip is edited into the Timeline such that the Source In point is aligned with the Timeline In point. This can be seen by the thick bar that extends to the right of the In point in the Timeline Ruler.

![A thick bar indicates where the Source clip will be edited in the absence of a Timeline Out point.](image)

– If you set a Timeline Out point but no Timeline In point: The incoming source clip will be backtimed so the Out point of the source clip is aligned with the Timeline Out point. This can be seen by the thick bar that extends to the left of the Out point in the Timeline Ruler.

![A thick bar indicates a backtimed edit in the absence of a Timeline In point.](image)

– If you set Timeline In and Out points but only a Source Out point: In this case, the incoming source clip will also be backtimed so the Out point of the source clip is aligned with the Timeline Out point, with the Timeline edit points defining the duration of the source clip being edited.

– If you set all four Source In and Out and Timeline In and Out edit points: The Timeline edit points dictate the duration of source clip that is edited into the Timeline, and the frame at the Source In point is aligned with the Timeline In point, unless you perform a Fit to Fill or ripple overwrite edit, both of which can be done as four-point edits.

**TIP:** If you want to use all four Source and Timeline edit points to retime a source clip to fit into a specific range of the Timeline, use a Fit to Fill edit instead of an overwrite edit.
Editing Rules for Split In and Out Points

If you’ve created split In and Out points in the Source Viewer or Timeline, the following rules apply:

– **If the Source Viewer has split In and Out Points:** The leftmost split point of the incoming clip, whether video or audio, will be aligned with the playhead when the clip is edited; the other split point will be offset to the right.

– **If the Timeline has split In and Out Points:** The In point of the incoming clip will be aligned with the leftmost split point, whether video or audio; the accompanying audio or video In point will be offset to the split point to the right.

Editing a Specific Range of the Source Clip Into the Timeline

This section provides some common examples of three-point editing when performing edits in the middle of a previously edited timeline. In the following example, you have a specific range of source media that you need to edit into the Timeline, and you don’t particularly care what gets overwritten in the Timeline by the incoming clip.

1. Set In and Out points in a source clip, either in the Media Pool or in the Source Viewer.

   ![Setting source clip In and Out points](image)

2. To set where you want the incoming clip to go, set the destination control to the tracks you want to edit onto, and then do one of the following:

   – Move the Timeline playhead to the frame you want to use as the Timeline In point for the edit.
   
   – Set a Timeline In point for the edit.

   ![Using the playhead to act as a Timeline In point](image)

3. To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or drag a clip onto the appropriate overlay in the Timeline Viewer.
The resulting edit; the duration of the source clip defines the duration of the edit

Editing Part of a Source Clip to Fit Into a Specific Range of the Timeline

In this example, you have a section of a clip or a gap in the edited sequence of clips in the Timeline that you want to fill with as much of the current source clip as it will take to “plug the hole.”

1. Set an In point in the source clip, if necessary, to define the first frame of the range of source media that you want to edit into the Timeline.

2. Set In and Out points in the Timeline to set both where you want the incoming clip to go, and how much of the incoming clip you want to use.
To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or drag a clip onto the appropriate overlay in the Timeline Viewer.

The resulting edit; the duration of the Timeline edit points define how much of the source clip is edited.

Backtiming a Source Clip When Editing Into the Timeline

In this last example, you’ve got a specific moment in the second half of a source clip that you need to align with an Out point in the Timeline, such that the remaining duration of the incoming clip overwrites the edited sequence of clips from the right to the left. This is referred to as backtiming, when you’re lining up a Source Out point with a Timeline Out point in order to make an edit, and can be set up one of two ways.

**Backtiming method one:**

1. Set In and Out points in the source clip, either in the Media Pool or in the Source Viewer.
2. Set an Out point in the Timeline, at the frame where you want the corresponding Out point of the incoming source clip to be aligned.

The resulting edit, aligning the Out point of the source clip with the Out point of the Timeline.

3. To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or drag a clip onto the overwrite overlay in the Timeline Viewer.

The resulting edit, the duration of the Timeline edit points define how much of the source clip is edited.
Backtiming method two:

1. Set an Out point in the source clip, either in the Media Pool or in the Source Viewer.
2. Set In and Out points in the Timeline to set both where you want the incoming clip to go, and how much of the incoming clip you want to use.

To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or drag a clip onto the appropriate overlay in the Timeline Viewer.

Setting up a backtimed edit by setting an Out point in the Source Viewer, and In and Out points in the Timeline to define the duration of the edit.

The resulting edit, aligning the Out point of the source clip with the Out point of the Timeline.

Switch Focus to Timeline After Edit

A setting in the Edit menu, “Switch focus to timeline after edit” (Option-Shift-Q), lets you set whether or not DaVinci Resolve changes the application focus from the Source Viewer to the Timeline Viewer/ Timeline every time you make an edit. This setting is on by default.

For example, if you’re assembling clips from many different source files into the Timeline, and trimming the results as you go, leaving this option on may save you time. In this case, after every edit, the focus switches from the Source Viewer to the Timeline, so you can quickly select the clip or edit point you want to trim and make your adjustments before loading the next clip into the Source Viewer in preparation for the next edit.

On the other hand, if you’re editing several pieces from a long interview clip into the Timeline, you may want to turn this setting off to make it easy to continue playing forward in the Source Viewer, setting In and Out points and editing clips into the Timeline as you go. After every edit, focus remains on the Source Viewer, so you can continue making edits from the same source clip without interruption.
Different Types of Three- and Four-Point Edits

This section covers the different types of edits that are available for cutting source clips into the currently open Timeline.

Overwrite Edits

The most common type of edit you’ll make, an overwrite edit eliminates whatever media was in the Timeline previously with the incoming source clip taking the place of whatever was there. Overwrite edits are commonly used when initially assembling clips, or doing three-point editing.

Overwrite edits do not ripple the Timeline.

To overwrite one or more clips in the Timeline:

1. Move the playhead to the frame of the Timeline where you want to insert a clip.
2. Click the appropriate audio and video destination controls of the tracks you want to edit the incoming source clip onto. If necessary, create new tracks.
3. Select a single clip in the Media Pool to open it into the Source Viewer, then set In and Out points to define the range of media you want to insert.
4. To make the edit, choose Edit > Overwrite, click the Overwrite Clip button in the toolbar, press the F10 key, or drag a clip onto the Overwrite overlay in the Timeline Viewer.

Before and after an overwrite edit, the Timeline duration stays the same.

The selected clips in the Media Pool are overwrite edited to the selected track starting at the position of the playhead, eliminating whatever was there originally while adding incoming clip. No other clips are rippled during this operation.
Insert Edits

An insert edit splits whatever media is already in the Timeline at the position of the playhead, and pushes that media to the right to make room for the incoming clip.

Insert edits have the effect of rippling almost all clips in the Timeline that are to the right of the insert edit point you’re making, pushing them farther to the right by the duration of the incoming source clip. However, clips in any tracks of the Timeline that overlap to the left of the insert edit point aren’t rippled, and remain in place.

For example, if you’re insert editing a clip into the middle of a sequence of clips in track V1 and A1 of the Timeline, and there’s also a clip of music edited into track A2 that overlaps well to the left of the insert edit point, the music clip remains where it is, but the other clips on track V1 and A1 that are to the right of your edit point on are pushed to the right.

To insert edit one or more clips into the Timeline:

1. Move the playhead to the frame of the Timeline where you want to insert a clip.
2. Click the appropriate audio and video destination controls of the tracks you want to edit the incoming source clip onto. If necessary, create new tracks.
3. If necessary, set In and Out points in the clip or clips you want to insert edit into the Timeline using the controls of the Media Pool or the Source Viewer.
4. Do one of the following:
   - Select one or more clips in the Media Pool, right-click one of the selected clips, and choose “Insert Selected Clips to Timeline.”
   - Choose Edit > Insert, click the Insert Edit button in the toolbar, press the F9 key, or drag any clip onto the Insert overlay in the Timeline Viewer.

The selected clips are insert edited to the selected track at the position of the playhead, pushing all other media in the destination track back by the total duration of the selected clips, except for clips on other tracks that overlap to the left of the edit point (as seen by the overlapping music clip in the example below).
Replace Edits

Replace edits are a unique three-point edit type that aligns the frame at the Source Viewer playhead with the frame at the Timeline playhead when the edit is executed. This is the fastest edit type to use when you need to align an action at a specific frame of video, or a sound at a specific frame of audio, to a particular frame’s action or sound in the video or audio of the Timeline.

The fastest way of using the replace edit is to not bother setting either In or Out points in the Source Viewer, and to either use the duration of an existing clip intersecting the Timeline to define the edit, or a pair of timeline In/Out points specifying either a section of a clip you want to overwrite, or an empty section of the Timeline to which you want to edit.

Replace edits do not ripple the Timeline.

Replace Edits to Replace Existing Clips in the Timeline

A replace edit automatically replaces an existing clip in the Timeline with a clip in the Source Viewer, so long as that clip overlaps the playhead and is on a track with its destination control enabled. When you make a replace edit in this way, DaVinci Resolve automatically uses the duration of the Timeline clip to define the duration of the incoming media, and the positions of the Viewer and Timeline playheads to line up how the incoming media should be placed. This is an extremely fast edit to make, since you needn’t use any In or Out points at all.

To replace a clip in the Timeline:

1. Move the playhead in the Timeline to the clip that you want to replace, and align it with a frame that you want to line up with a frame in the clip you’ll be replace editing into the Timeline.
2. Click the appropriate audio and video destination controls of the track containing the clip you want to replace.
3. Open a clip into the Source Viewer.
4. Move the playhead in the Source Viewer to the frame that you want to line up with the frame at the position of the playhead in the Timeline.

In the example shown below, the original clip that was shot on location of a car driving past a slab of real concrete (shown in the Timeline Viewer at right) is going to be replaced by a VFX shot of a concrete wall with a small hole for the car to drive through (shown in the Source Viewer at left). The playhead in the Source Viewer is aligned on the very same frame as the playhead in the Timeline Viewer, which can be seen by the identical position of the white stripe on the road in the lower right-hand corner of the picture.
Now that the playheads are aligned on the frames that must match one another in both the Source and Timeline Viewers, choose Edit > Replace, click the Replace Clip button in the toolbar, press F11, or drag any clip onto the Replace overlay in the Timeline Viewer.

The resulting replace edit, in which the original timeline clip is replaced by the incoming Source Viewer clip by aligning the frames at each playhead.

The camera original clip in the Timeline is now replaced with the VFX source clip from the Media Pool, with the source frame at the Source Viewer playhead aligned with the frame at the Timeline playhead.

Replace Edits to Edit Clips Into Empty Tracks

You can also use a replace edit to edit a clip into an empty track of the Timeline so that the frame at the position of the Source playhead is aligned with the Timeline playhead, and the In and Out points of the incoming clip fall where they may. This is useful when you want to “spot” a particular action of an alternate take or a cue in a sound effect to a specific frame of the Timeline.

To use replace edit to spot a sound effect or action video clip into the Timeline:

1. Move the playhead in the Timeline to the clip that contains the moment you want to align the new incoming audio or video clip with, and position it on the exact frame that you want to line up with a frame of the clip you’re going to edit into the Timeline.

2. Click the appropriate audio and video destination controls of the empty track you want to edit the incoming clip into.

3. Open a clip into the Source Viewer.

4. Move the playhead in the Source Viewer to the frame that you want to line up with the frame at the position of the playhead in the Timeline. This may be the sample of a sound effect that corresponds to the action in a particular frame of your program’s video, or a frame of video that corresponds to a particular sound in your program’s audio.

   In the example shown below, the beginning of an audio cue of a billiard ball being hit is being lined up with the frame in which the cue ball is first hit in the video.

5. If necessary, set In and Out points in the Timeline to restrict how much of the incoming clip will be edited. Otherwise, the entire source clip will be edited into the Timeline.

In the Source Viewer to the left is an SFX clip we want to edit into the Timeline to match the visuals of a cue ball being hit, shown in the Timeline Viewer at right.
Now that the playheads are aligned on the frames that must match one another in both the Source and Timeline Viewers, choose Edit > Replace, click the Replace Clip button in the toolbar, press F11, or drag any clip onto the Replace overlay in the Timeline Viewer.

The resulting replace edit, in which the incoming Source Viewer clip is aligned perfectly with the video.

The SFX source clip has now been edited into the specified audio track, with the source frame at the Source Viewer playhead perfectly aligned with the frame at the Timeline playhead so that the cue ball hit is in sync with the visuals.

Replace Edit Using Clips Already in the Timeline

To facilitate workflows where multiple clips are stacked in the Timeline to manually track different takes or versions of stock footage, VFX clips, or other versionable media, there’s a method of drag and drop replace editing that copies the grade of the clip being replaced to the clip you’re replacing it with at the same time, so that newer versions of effects can inherit the same grade as the previous version of the effect being replaced. This only works for clips that have already been edited into the Timeline and that are superimposed (over or under) other clips in the Timeline, such as in the following screenshot. Be aware that this technique can also be used for multiple selected clips on the Timeline to do several replace edits all at once.

(Left) Before replace editing a clip in the Timeline, (Right) After Command-dragging a clip over one under it in the Timeline to replace edit the one below with the one above
To replace edit one clip that's stacked on the Timeline into another:

1. Select one or more clips that are already on the Timeline. Typically these will be clips that are superimposed over other clips.

2. Hold the command key down while dragging one superimposed clip on top of another to overwrite a clip and copy its grade to the clip you’re overwriting it with.

**NOTE:** This won’t work with clips you’re editing into the Timeline from the Media Pool or Source Viewer.

**Fit to Fill**

Fit to fill edits are the only edit type that actually use all four edit points, and it’s the only edit type that retimes clips at the same time as they’re being edited. By setting In and Out points in the incoming source clip, and another pair of In and Out points in the Timeline, you can stretch or compress the timing of the specified range of source media to cover the entire specified range of the Timeline. In the process, the speed ratio of the clip changes so the clip plays in either fast or slow motion.

Fit to fill edits are especially valuable when you have a source clip in which the action is slightly slow, and you just want to speed it up by squeezing it into a shorter duration of the Timeline. They’re also incredibly handy in situations when you have a gap in an edited sequence of clips to fill with a source clip that’s just not long enough, but in which slightly slower motion won’t be noticeable.

Fit to fill edits do not ripple the Timeline.

**To use fit to fill to edit a clip into the Timeline:**

1. Do one of the following to define where in the Timeline to edit the incoming clip:
   a. You can set both In and Out points in the Timeline, to define the duration you want to fill with the incoming source clip as a three-point edit.
   b. You can clear the Timeline In and Out points (pressing Option-X), so that you can instead use the duration of whichever clip or gap intersects the playhead on the track with the destination controls assigned to them. In the following screenshot, the clip can easily be edited to take the place of the gap by positioning the playhead anywhere within it.

![Setting timeline In and Out points to mark a gap](image)

2. Next, you’ll need to set both In and Out points in the Source Viewer to define a longer or shorter source clip that you want to fill into the available space. In this example, we have a very short section of the source clip defined that, because of the matching action in the Timeline, must be fit into the larger gap seen above.

![Setting In and Out points in a source clip to define a shorter duration segment that you want to completely fill the gap](image)
3 Click the audio and video destination controls of the tracks you want to edit the incoming source clip onto. If necessary, create new tracks.

4 Choose Edit > Fit to Fill, drag any clip onto the Fit to Fill overlay in the Timeline Viewer, or press Shift-F11.

The resulting edit; the shorter source clip is retimed to fit into the longer timeline gap.

The incoming source clip is retimed, as necessary, to fit into the specified duration of the Timeline. This can be seen by the retiming badge that appears within the clip that’s just been edited into the Timeline.

**Place on Top**

Place on top edits automatically superimpose clips onto the first empty track above (for video clips) or below (for audio clips) any other clips in the Timeline that either intersect the playhead or fall in between the currently set Timeline In and Out points, regardless of the current track specified by the destination controls. It’s designed to make it easy to superimpose titles and other clips you want to composite over another clip, or to add additional versions of clips such as VFX on top of previous versions that you want to preserve.

Place on top edits create new timeline tracks if necessary, and do not ripple the Timeline.

**To use place on top to edit a clip into the Timeline:**

1 To choose where in the Timeline the clip will be “placed on top,” do one of the following:
   - Move the playhead to intersect the clip you want to edit the incoming source clip on top of.
   - Set In and Out points in the Timeline to define the duration within which you want to place the incoming source on top.

2 Set In and Out points in a source clip that you want to edit.

3 Choose Edit > Place on Top, drag any clip onto the Place on Top overlay in the Timeline Viewer, or press F12.
Incoming video clips will be edited to the topmost video track so they are above any previously existing video in the Timeline. Incoming audio clips are edited to the bottom-most audio track so they are below any previously existing audio. If necessary, new video and/or audio tracks will be created automatically to hold the new incoming clip.

### Ripple Overwrite

Ripple Overwrite is a four-point edit that’s useful when you can identify a segment of the Timeline you want to overwrite, but the incoming clip is of a different duration and you want DaVinci Resolve to automatically ripple the Timeline to accommodate the difference.

You can use the Ripple Overwrite command one of two different ways:

- You can overwrite an entire clip in the Timeline with another clip of different length.
- You can overwrite a section of the Timeline marked with In and Out points with a another clip of different length.

In both cases, all clips to the right of the clip or timeline section being overwritten are rippled to the right or left to make room or fill the gap. Because of this, the ripple overwrite edit will most likely change the overall duration of your edited sequence of clips.

### Using Ripple Overwrite on an Entire Clip in the Timeline

Using ripple overwrite as an automatic four-point edit, you can overwrite whichever clip in the Timeline intersects the playhead on the tracks defined by the destination controls, in its entirety, with the incoming clip. For this to work, there must be no In or Out points set in the Timeline.

After performing a ripple overwrite in this way, the original timeline clip is eliminated and the incoming clip takes its place, and all clips to the right of the clip being replaced are either (a) rippled to the right if the incoming clip is longer than the original timeline clip, or (b) rippled to the left if the incoming clip is shorter than the original timeline clip. All of this is done in a single step.

This is useful in situations where you want to quickly switch one clip in the Timeline with another of unequal duration and have the Timeline automatically make room to allow this all in one step.

**To use ripple overwrite to replace an entire clip in the Timeline with another source clip:**

1. Move the playhead in the Timeline to intersect the clip that you want to replace; the playhead’s exact position is not important.
2. Click the appropriate audio and video destination controls of the track containing the clip you want to replace, and press Option-X to eliminate any In and Out points there might be in the Timeline.
3. Open a clip into the Source Viewer, and set In and/or Out points as necessary to define how much of the clip you want to edit into the Timeline.
4. To execute the edit, choose Edit > Ripple Overwrite, drag the clip to the Ripple Overwrite overlay of the Timeline Viewer, or press Shift-F10.
Using Ripple Overwrite on a Section of the Timeline Defined by In/Out Points

You can also use ripple overwrite as an explicit four-point edit, to overwrite a section of the Timeline that's marked with In and Out points with an incoming clip that's also marked with In and Out points that is of unequal duration.

After performing a ripple overwrite in this way, the section of the Timeline marked with In and Out points is eliminated and the incoming clip takes its place, and all clips to the right of the clip being replaced are either (a) rippled to the right if the incoming clip is longer than the original timeline clip, or (b) rippled to the left if the incoming clip is shorter than the original timeline clip. All of this is done in a single step.

A good example of when this can be useful is when you're cutting a close-up of an actor performing a particular action into a medium shot of the actor performing the same action that's already in the Timeline, and the action you're matching is of different durations in each of the shots.

To use ripple overwrite to replace a section of the Timeline with another source clip:

1. Set In and Out points in the Timeline to mark what part of the clip or clips you want to overwrite. You must set both In and Out points for this to work as expected. In this example, the part of the clip where the woman leans forward is marked.
2 Open a clip into the Source Viewer, and set In and/or Out points as necessary to define how much of the clip you want to edit into the Timeline. In this example, a section of the woman’s close up where she leans forward in a way that matches the same movement in the wider shot is marked.

Setting In and Out points to identify an action in a source clip that you want to overwrite the action you’ve marked in the Timeline. It’s a matching action, but the timing might be different, and that’s okay with this kind of edit.

3 To execute the edit, choose Edit > Ripple Overwrite, drag the clip to the Ripple Overwrite overlay of the Timeline Viewer, or press Shift-F10. As a result, the section of the timeline that was marked in step 1 is overwritten by the section of the source clip marked in step 2, and all clips to the right of this edit in the Timeline are rippled to the right to make room for the much longer source clip. The final result is an edit where the movements match nicely.

After the ripple overwrite, the part of the Timeline clip marked with In and Out points has been overwritten by the part of the Source clip marked with In and Out points, and all clips to the right of this edit in the Timeline are rippled left or right as necessary.

Append at End

Append at end always puts the edited clip at the very end of the current Timeline. It’s a very useful edit type when you’re quickly stringing together a series of clips.

To use append at end to edit a clip into the Timeline:

1 Set In and Out points in a source clip that you want to add to the end of the current Timeline. If necessary, change the sort order of the Media Pool to put these clips into the order in which you want them to be added to the Timeline.
2 Click the audio and video destination controls of the tracks you want to edit the incoming source clip onto. If necessary, create new tracks.

3 Choose Edit > Append to End Of Timeline, drag the clip to the Append at end overlay of the Timeline Viewer, or press Shift-F12.

Incoming video clips are added after the very end of the last clip in the Timeline.

Insert Selected Clips to Timeline Using Timecode

Clips can be edited directly from the Media Pool into a timeline, such that each clip’s source timecode is aligned with an identical record timecode value in the Timeline. This can be useful for long form multi-camera events, like weddings or concerts, where all cameras are linked by the same timecode to ensure all edits are perfectly synced. This function matches the Source Overwrite edit on the Cut page.

IMPORTANT

The timecode of the Timeline must overlap the timecode of the clip(s) for this edit to function. This can be set in the Start Timecode field of the New Timeline settings.

To insert selected clips to timeline using timecode:

1 Select one or more clips to edit into the Timeline in the Media Pool. If there are In and Out points set on the clip, the edit will respect those boundaries. If no In/Out points are set, each selected clip’s full duration will be edited in its entirety.

2 Set a destination control to determine which track in the Timeline you want to edit to.

3 Right-click one of the selected clips and choose “Insert Selected Clips to Timeline Using Timecode” from the drop-down menu.

4 All of the selected clips will be overwritten into the Timeline at their appropriate timecode locations onto the destination track.

IMPORTANT

If multiple selected clips have overlapping timecode, no edit will occur.

Insert Selected Clips to Timeline With Handles

"Insert Selected Clips to Timeline With Handles" is a command that’s available from the Media Pool contextual menu for editing one or more selected clips to the currently open timeline, such that the default handle length is subtracted from the beginning and end of each clip. The goal is to make it easy to string together a series of clips that you want to connect using transitions by automatically changing the In and Out points of each clip being edited into the Timeline in order to add handles.

To use insert selected clips to timeline with handles to edit one or more clips into the Timeline:

1 Select one or more clips in the Media Pool that you want to add to the Timeline. If necessary, change the sort order of the Media Pool to put these clips into the order in which you want them to be added to the Timeline.

2 Click the audio and video destination controls of the tracks you want to edit the incoming source clip onto, and position the playhead where you want the incoming clips to start. If necessary, create new tracks.
3 Right-click one of the selected clips in the Media Pool and choose "Insert selected clips to timeline with handles" from the contextual menu.

The selected clips are added to the Timeline starting at the position of the playhead.

To change the length of handles that are removed, open the Editing panel of the User Preferences and change the "Default handles length" setting. Handles will not be added in either of the following two cases:

– If any of the selected clips in the Media Pool already have handles because of In and Out points that you've set, then additional handles won't be added.

– If the duration of the frames to be removed to create handles in this operation is greater than the duration of one or more of the clips you've selected in the Media Pool, then handles won't be added at all.

Three-Point Editing From the Media Pool

You can also execute three-point edits directly from the Media Pool, with no need to use the Source Viewer.

Example: Assembling Clips Into the Timeline From the Media Pool

If you want, you can also edit clips directly into the Timeline from the Media Pool using a variety of commands. This can be a fast way of appending clips to the end of the Timeline (although you can also perform insert edits this way).

To edit one or more clips from the Media Pool to the Timeline:

1 If necessary, set In and Out points for each of the clips you want to edit into the Timeline using either the Media pool thumbnails (in Thumbnail view), the Media Pool Filmstrip Viewer (in List view), or by opening each one into the Source Viewer. For each method, press I to set an In point, and O to set an Out point.

2 Change the sort order of the Media Pool's browser area to put the clips into the order in which you want them to appear. In Thumbnail view you can use the Sort Order menu, but in List view you can click the header of any metadata column to sort by that column's data.

3 Position the playhead to where you want to edit the clips.

4 Click, drag, use the Command-Option and Command-Shift Up and Down Arrow Key shortcuts, or use the Option-1–8 and Command-Option-1–8 key shortcuts to assign the video and audio destination controls to the tracks you want to edit the video and audio of the incoming clip(s) to. Click any destination control itself to disable it if you want to edit clips into the Timeline as audio or video only.

5 Select one or more clips you want to edit. Insert, overwrite, place on top, ripple overwrite, and append at end edits are all capable of editing multiple clips at once, while replace and fit to fill edits can only edit one clip at a time, and will only edit the first of multiple selected clips into the Timeline.

6 To perform the edit, do one of the following:

– Drag the selected clips to the Timeline Viewer and drop them on an editing overlay to execute that edit type.

– Right-click one or more selected clips in the Media Pool, and choose “Insert Selected Clips to Timeline,” or “Append Selected Clips to Timeline.”

The selected clip(s) are edited into the Timeline.
As you work on your project, you’ll find it useful to identify important information about each clip, and about significant moments in each timeline, using a combination of Flags, Markers, and clip Label colors. These can be applied to source clips in the Media Pool, or to clips that have already been edited into timelines. In the case of markers, these can also be added to the Timeline ruler itself to help you keep track of important moments or notes, and to help you with snapping. You’ll also find yourself modifying clips in different ways, unlinking and relinking the audio and video of different clips, enabling and disabling clips in the timeline.
Using Markers in the Media Pool 707
Hiding Markers By Color 707
Deleting Markers By Color 708
Renaming Clips in the Timeline 708
Color Labeling Clips in the Timeline 709
Custom Clip Colors 709
Clip Color Appearance 709
Assigning Clip Colors 710
Track Colors 710
Finding Clips, Media, Markers, Gaps, and Timelines 711
Finding Clips in the Timeline 711
Finding Offline Clips in the Timeline 712
Finding Edit Index Events Using Clips in the Timeline 712
Finding Clips 712
Finding Clips Using Markers or Flags 713
Finding Gaps 713
Finding the Currently Open Timeline in the Media Pool 713
Finding Media Using Match Frame Operations 714
Matching From the Timeline 714
Matching From a Source Clip 715
Finding a Clip in the Media Pool Using a Timeline Clip 716
Using a Clip in the Source Viewer to Find a Media Pool Clip 716
Using a Clip in the Timeline to Find a Media Pool Clip 716
Tracking Media Usage 716
Thumbnail Clip Usage Indicators 716
List View Clip Usage Column 717

Using Flags

Flags are meant to mark an entire clip, and they also flag every other clip in the Timeline that shares the same Media Pool source clip, making this a handy way of quickly identifying which clips in a given timeline come from the same Media Pool source.

The Flag and Marker buttons and pop-ups.

You can apply multiple flags to clips, with a variety of colors to choose from. In addition to flagging specific media files, flags can be useful for timeline filtering in the Color page, sorting by column in the Media Pool, and a variety of other operations.
Methods for flagging clips:

– To flag a clip using the toolbar: Select one or more clips, and either click the Flag button to flag that clip with the current color, or click the Flag drop-down in the toolbar to choose a different color and then click the Flag button. In the Edit page, flags appear in the Timeline superimposed in the name bar of each clip.

– To flag a clip: Select one or more clips, and Choose Mark > Add Flag > Current Selected (G) to add a markers of a specific color directly to clips and the Timeline. The individual flag color commands can be assigned specific keyboard shortcuts if you want to be able to place a specific flag color at a keystroke.

– To flag a clip in the Source Viewer: Open a clip in the Source Viewer, and while the Source Viewer has focus, choose Mark > Add Flag > Current Selected (G). The individual flag color commands can be assigned specific keyboard shortcuts if you want to be able to place a specific flag color at a keystroke.

– To remove all flags from a clip: Select one or more clips with flags you want to remove, then click the Flag drop-down in the toolbar, and choose the top “Clear All” option.

– To show or hide a particular color of flags: Choose a color of flag to hide from the View > Show Flags submenu, or choose View > Show Flags > All to show them all.

– To filter all flagged clips in the Edit Index: Click the Option menu of the Edit Index and choose Show Flags. Each flagged clip appears in a list, with a column showing the color(s) of the flags applied to each entry in the list.

Using Markers

Markers are used to call attention to a particular frame within a specific clip. Markers can be individually colored, and can have customized name and note text. Whenever you enter text into a marker, that marker displays a small dot that indicates there’s more information inside of it. Once placed, markers snap to In and Out points, edit points, the playhead, and other markers whenever snapping is enabled, making it easy to use markers to “measure” edits and trims that you make in the Timeline.

Adding Markers to Clips

You can place markers on the jog bar of source clips in the Source Viewer (or in the Media page Viewer), and on clips that are selected within a timeline.
When you add markers to a source clip, those markers also appear in the Media Pool as hierarchically disclosable items attached to that clip in List view (markers are not visible in Thumbnail view). More information about using markers in the Media Pool’s List view appears later in this chapter.

Markers can be viewed as separate clips identified by marker name when the Media Pool is set to List view.

The following procedures describe how to add markers to clips and timelines in DaVinci Resolve.

To mark a source clip in the Source Viewer or Media Page Viewer, do one of the following:
- To place a marker without doing anything else, move the playhead to the frame you want to mark, and then press M.
- To place a marker and immediately open the marker dialog to enter a name or note within it during playback, press Command-M (or press M twice). Playback pauses until you enter the text you want to and close the marker dialog again, at which point playback continues.
- Move the playhead to the frame you want to mark, then right-click in the jog bar and choose a marker color from the Add Marker submenu of the contextual menu.

To mark a clip in the Timeline, do one of the following:
- Select one or more clips you want to mark, then move the playhead to the frame of a selected clip in the Timeline, and click the Marker button in the toolbar (or press M) to place a marker at that frame, using the current color (if multiple overlapping clips are selected, you’ll add a marker to all clips).
- To place a marker during playback and immediately open the marker dialog to enter a name or note within it, select one or more clips you want to mark, play through the selection until you want to place a mark, then press Command-M (or press M twice). Playback pauses until you enter some text and close the marker dialog again, at which point playback continues.
- Select one or more clips you want to mark, and then click the Marker drop-down to choose a different color, and click the Marker button.
Adding Markers to Timelines

You can also place markers of any color into the Timeline ruler to denote specific times for future reference, or add notes about issues you want to keep track of.

![Timeline markers placed for future reference](image1)

You should note that all markers placed on clips or in the Timeline also appear within the Mini-Timeline of the Color page, making it easy to place notes for later reference when grading.

![Clip and Timeline markers as seen in the Mini-Timeline of the Color page](image2)

Once you've added one or more markers placed on clips, snap to clip In and Out points, edit points, the playhead, and other markers whenever snapping is enabled.

**To mark the Timeline itself, make sure all clips are deselected, and do one of the following:**

- Press M.
- Click the Marker button to place a marker of the currently selected color in the Timeline ruler.
- To place a marker during playback and immediately open the marker dialog to enter a name or note within it, select one or more clips you want to mark, then press Command-M (or press M twice). Playback pauses until you enter some text and close the marker dialog again, at which point playback continues.
- Click the Marker drop-down to choose a different color, and click the Marker button.
- Right-click in the Timeline ruler and choose a marker color from the Add Marker submenu of the contextual menu.
- Choose Mark > Add Marker > Current Color (M) to add the current marker color. Alternatively, you can choose Mark > Add Marker > Blue/Cyan/Green/and so on to add a marker of a specific color directly to clips or the Timeline. These commands can be assigned specific keyboard shortcuts if you want to be able to place a specific marker color at a keystroke.
Individually mappable marker color commands

Saving In and Out Point Ranges As Markers with Duration

You can also create markers with duration to keep track of any region of a clip or timeline that you’ve defined with In and Out points. This lets you identify multiple regions of a clip that you might later want to edit into a program.

To turn In and Out points into a marker with duration:

1. Set In and Out points in the Source Viewer jog bar to identify a region you want to log for future reference.

2. Do one of the following:
   - Right-click the jog bar and choose Convert In and Out to Duration Marker
   - A marker with duration appears above the In and Out points. To edit its name or notes, double-click the marker, press Shift-M, or choose Mark > Modify Marker.

In this way, you can log several regions within a single clip for future use.
This an extremely useful logging technique for two reasons. First, markers with duration can be searched for in the Media Pool using the All Fields, Marker Name, and Marker Notes Filter by options. Second, they can be filtered with Smart Bins using the Marker Name and Marker Notes Media Pool Properties options.

Editing Marker Information and Keywords

Once you’ve added some markers, you may want to edit their contents to make them more useful.

To open a marker's edit dialog to alter its properties:

1. Do one of the following:
   - Press Command-M to add a marker during playback and immediately open its edit dialog.
   - Double-click any marker you want to edit.
   - Move the playhead to the frame containing the marker you want to annotate using Shift-Up Arrow/Down Arrow and press M.
   - Select a marker anywhere in the Source Viewer or Timeline, and press Shift-M.

2. When the marker dialog opens, you can modify several properties in separate fields. For fast editing, you can press Tab to select the next field, or you can press Shift-Tab to select the previous field.

   - **Time**: The frame the marker is positioned at relative to that clip or timeline. This is editable, so you can numerically change a marker’s position.
   - **Duration**: Optional; the length of a marker that’s been assigned a duration. This is also editable, so you can numerically assign a duration to a marker or alter a marker that already has duration.
   - **Name**: The name of the marker, defaults to the number of that marker in the order it was added (Marker 1, Marker 2, etc.).
   - **Notes**: A field where you can enter any information you want to keep track of.
   - **Color**: A series of buttons for choosing the color of the marker.
   - **Keyword**: A keyword field lets you keyword markers in the same way you can keyword clips in the Metadata Editor, which can be a powerful way of identifying sections of clips you want to find later in Smart Bins or Search operations. Typing text in the Keyword field automatically searches the dictionary for matching keywords. Press Return to accept a found keyword (you can choose from a list using the Arrow keys), or press the Up Arrow key back to the Keyword field to manually enter your own new variation instead. For more information about using and editing Keywords, see Chapter 15, “Using Variables and Keywords.”
3 When you’re finished, click Done.

Once you add notes to a marker, a small symbol appears on top of that marker to show you it has information.

Changing Marker Timing

Once you’ve placed one or more markers, there are a variety of ways you can move them around to better line up with important events in source footage or the Timeline, or delete them once they’re no longer useful. Additionally, you can enable or disable the ability to have markers ripple along with other clips in areas of the Timeline that are affected by rippling operations.

To move one or more markers in the Timeline or Source Viewer:
- Click a marker or Command-click multiple markers you want to move, and drag them to a new location.
- Drag a bounding box from the Timeline up into the Timeline ruler to select multiple markers, and drag them to a new location.
- Open a marker’s edit dialog and manually edit the time and duration timecode fields to numerically move that marker, or to create a marker with a specific duration. Furthermore, the timecode in these fields can be copied from or pasted to.

To enable marker rippling:
- Choose Timeline > Ripple Timeline Markers. When checked, all markers to the right of a clip being ripple edited, trimmed, or ripple deleted will ripple to the left along with the rest of the Timeline. You can turn this behavior off and on at will.

To modify marker duration:
- Option-drag any marker to the right or left to create a marker with duration.
- Move the playhead to the frame containing the marker you want to modify and press M, or double-click the marker you want to edit, then type a number into the duration field, and click Done.
- Markers with duration appear as a bar in the Timeline ruler or jog bar of the Source Viewer. Drag the middle of a marker with duration to move it, or drag the left or right edge to change its duration.
- To eliminate a marker’s duration, set its numeric duration to 00:00:00:00 in the marker dialog, or drag either end so that it merges with the other as a single marker.
Methods of deleting markers:

- **To remove one or more markers using the mouse:** Click to select a marker, or Command-click to select multiple markers, and press the Delete key. You can also double-click a marker to open its dialog, and click the Delete button.

- **To remove a marker using the keyboard:** Move the playhead to the marker you want to delete, and press Option-M.

- **To remove all markers from a clip:** Select one or more clips with markers you want to remove, then either press the Backspace key, or click the Marker drop-down in the Toolbar, and choose Clear All.

- **To remove all markers from the Timeline:** With all clips deselected, choose Clear All from the marker drop-down menu in the Toolbar, or right-click the Timeline ruler, and choose Remove All Markers from the contextual menu.

Drawn Annotations on the Viewer

It’s now possible to use the Annotations mode of the Timeline Viewer to draw arrows and strokes of different weights and colors directly on the video frame, in order to point out or highlight things that need to be fixed. These annotations are stored within markers, similarly to marker names and notes. To start, simply choose Annotations mode from the Timeline Viewer mode drop-down menu.

![Choosing Annotations from the Viewer Mode drop-down menu](image)

Once in Annotations mode, an Annotations toolbar appears showing the following options:

- **Draw tool with line weight drop-down:** Click the Draw tool to be able to freeform draw on the Viewer. Click the Line Weight drop-down to choose from one of three line weights to draw with.

- **Arrow tool:** Click the Arrow tool to draw straight-line arrows pointing at features you want to call attention to. Arrows are always drawn at the same weight, regardless of the weight selected for the Line tool.

- **Line Tool:** Click the Line tool to draw straight lines on the Viewer.

- **Rectangle Tool:** Click the Rectangle tool to draw boxes on the Viewer.

- **Color drop-down:** Choose a color for drawing or lines.

![The Annotations toolbar in the Viewer](image)
Methods of making and editing annotations:

– **To create an annotation:** Simply enable Annotations mode, then park the playhead on any frame of the Timeline and start drawing. A marker will automatically be added to the Timeline at that frame, and that marker contains the annotation data. If you park the playhead over a preexisting timeline marker, annotations will be added to that marker.

– **To edit a stroke or arrow you’ve already created:** Move the pointer over a stroke or arrow and click to select it, then choose a new line weight or color from the appropriate drop-down menu, or drag that stroke or arrow to a new location to move it.

– **To delete a stroke or arrow:** Move the pointer over a stroke or arrow and click to select it, then press the Delete or Backspace keys.

Drawing annotations to highlight feedback

**Frame.io Timeline Markers**

If you’re using DaVinci Resolve alongside a Frame.io account, there is some powerful integration that manifests itself as markers in the Timeline. When you render a timeline directly to Frame.io, that timeline is automatically linked to the movie that’s been uploaded to Frame.io, and all comments, “Likes,” and graphical annotations (drawings and arrows) from reviewers that are added online via the Frame.io interface are automatically synced to Frame.io markers on your timeline (so long as your computer has an active internet connection). Frame.io markers are distinct from all other markers and can be independently shown and hidden, or deleted. Drawings and arrows from Frame.io are converted into their equivalent DaVinci Resolve annotation graphics for visibility in DaVinci Resolve.
Comments and graphical annotations from Frame.io appear as markers with their corresponding overlays in your DaVinci Resolve timeline.

**Working With Frame.io Markers**

Double-clicking any Frame.io marker in the Timeline opens a dialog that lets you send replies to comments that appear on Frame.io, enabling editors to respond directly to commenters.

![Frame.io Marker Dialog](image)

The editor talking to himself using the Frame.io comment dialog that appears when you open a Frame.io marker.

If you hover the pointer over any comment, three buttons appear to the right that let you edit that comment, delete it, or "Mark as complete."

![Hovering over Comment](image)

Hovering the pointer over a comment reveals buttons to edit it, delete it, or mark it as complete.
You can also place Frame.io markers on the Timeline to have them automatically sync back to Frame.io, giving you the ability to send your own comments back to commenters (be kind).

If you delete one or more Frame.io markers on the DaVinci Resolve timeline, those markers will also be deleted in Frame.io. This includes the Mark > Delete All Markers > Frame.io command. This is not undoable.

For more information about Frame.io integration with DaVinci Resolve, see Chapter 12, “Frame.io Integration.”

Reading Marker Information

Once you’ve added a number of markers with custom information, there are two ways of viewing this information without having to open the marker dialog.

To read marker notes using your pointer:
- Double-click a marker to open its marker dialog.
- Move the pointer over any marker in the Source Viewer or Timeline to see a tooltip showing that marker’s information.

To read marker information in the Source and/or Timeline viewers:
1. Open the Source or Timeline Viewer’s option menu, and turn on Show Marker Overlays.
2. Stop playback, and move the playhead to a marker. That marker’s information is displayed in the Viewer, superimposed.

Using Markers for Navigation

Markers can be used to aid navigation, via two keyboard shortcuts that let you jump the playhead from marker to marker. When moving the playhead among markers, Clip and Timeline markers are mixed together.

To move the playhead to the next or previous marker:
- Press Shift-Up Arrow to move the playhead to the next marker to the left in the Timeline.
- Press Shift-Down Arrow to move the playhead to the next marker to the right in the Timeline.
To move the playhead to a specific marker using the Source or Timeline Viewer’s Marker list:

– For a source clip or timeline with multiple markers, you can move the playhead immediately to a specific marker by opening the Source or Timeline Viewer’s Option menu, and choosing a marker from the Markers submenu, which exposes all the markers that are available in that Viewer, by name and note.

Exposing Markers in Lists

You can also use the Edit Index to filter out a list of markers appearing within the current Timeline. You can filter all markers at once, in which case columns expose the notes and colors applied to each marker. You can also filter by a specific marker color if you only want to see one type of marker.

Methods of working with markers in the Edit Index:

– **To filter all clips with markers in the Edit Index:** Click the Option menu of the Edit Index and choose Show Markers > All or choose a specific color. Each clip with a matching marker appears in a list, with columns corresponding to the color(s) and notes of each Timeline and Clip marker.

– **To move the playhead to the position of a marker in the Edit Index:** Click that marker’s entry in the list.

– **To show hidden marker columns:** Right-click any column header, and turn on either Color or Notes to reveal that column. If necessary, columns can be rearranged by dragging them left or right.

You also have the option to export lists of markers as an EDL, a .txt, or .csv file.

Exporting lists of markers:

– **To export Timeline markers as an EDL:** Right-click that timeline in the Media Pool, and choose Timelines > Export > Timeline Markers to EDL. Choose a location and export format from the Export Edit Index dialog, and click Save. Each Timeline marker is listed in the resulting EDL, with any notes included along with a duration, where applicable.

– **To export all filtered markers in the Edit Index as a .txt or .csv file:** After you choose Show Markers in the Edit Index option menu, then right-click that timeline in the Media Pool, and choose Timelines > Export > Edit Index. Choose a location and export format from the Export Edit Index dialog, and click Save.
Using Markers in the Media Pool

Once you’ve added one or more markers to source clips in the Media Pool, you can use them for editing in a considerably more direct way than just using them to move the playhead around. Markers can be exposed in the List view of the Media Pool, and once exposed, they can be opened into the Source Viewer, edited into the Media Pool, or turned into subclips just like any other clip.

To show markers in the Media Pool:

– Set the Media Pool to List view, then click the disclosure button to the left of the clip with markers you want to work with. They appear as a hierarchical list underneath the clip to which they’re attached.

![Markers exposed in the Media Pool in List view](image)

To open a marker in the Media Pool into the Source Viewer:

– Double-click any marker to open that clip into the Source Viewer with the playhead at the position of that marker.

To edit a clip defined by the marker into the Timeline:

– Drag any marker into the Timeline. A clip will be edited into the Timeline with the In point defined as the frame at the marker, and the Out point defined by either (a) the frame before the next marker in that clip, or (b) the duration of that marker if the duration is greater than the default 1 frame.

To turn a marker in the Media Pool into a subclip:

– Select one or more markers, and drag the selection into another region of the Media Pool, or into another Bin, and a sub clip will be generated with the clip start defined as the frame at the marker, and the clip end defined by either (a) the frame before the next marker in that clip, or (b) the duration of that marker if the duration is greater than the default 1 frame.

Hiding Markers By Color

View > Show Markers enables users to either show and hide markers based on color, or show them all at once. An example of when this is useful is when you’re using the color of markers to send information to specific artists, such as green for Fairlight mixing notes, or orange for Fusion page compositing notes. Users on those pages can then hide all other markers except for the color they’re interested in, enabling them to visually prioritize only the markers they care about.
Deleting Markers By Color

Mark > Delete All Markers lets users remove all markers of a specific color all at once, or remove all markers altogether.

Renaming Clips in the Timeline

For organizational purposes, you can create custom clip names that are tied to a specific timeline. This can be useful to display information about a clip that is persistent, readily apparent, and does not require you to click on a flag or marker to view. Clips renamed in this manner are only changed in the current timeline, and do not modify the Clip Name in the Media Pool.

You can rename clips on the Timeline by using the File Inspector and entering a new name in the Name field.

Renaming a clip in the File Inspector’s Name field.

The new name will show in the Timeline track at bottom of the clip.

The new clip name shown in the Timeline.

IMPORTANT

Changing a clip name in the Timeline only affects the instance of the clip in that specific Timeline. It does not rename the original Clip Name in the Media Pool, nor does it rename that same clip that may exist in other timelines. If you want to rename a clip across your entire DaVinci Resolve project, modify the Clip Name in the Media Pool instead.

TIP: If you want to use a custom clip name on more than one timeline, you can copy and paste the clip between timelines, and the pasted clip will retain its custom name. However both clip names will be independent from each other from that point forward.
**Color Labeling Clips in the Timeline**

By default, different clips have specific colors that identify each type of clip. Furthermore, clips with effects applied to them (adjustments in the Inspector, volume level changes, speed changes, and so on), appear as a darker shade of their default color to help you identify at a glance which clips have been modified. The following table lists what these default colors are.

<table>
<thead>
<tr>
<th>Clip Type</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Clip</td>
<td>Steel Blue</td>
</tr>
<tr>
<td>Audio Clip</td>
<td>Light Green</td>
</tr>
<tr>
<td>Generator</td>
<td>Light Purple</td>
</tr>
<tr>
<td>Text</td>
<td>Beige</td>
</tr>
<tr>
<td>Clip with effects</td>
<td>Shaded darker</td>
</tr>
</tbody>
</table>

**Custom Clip Colors**

Additionally, you can assign one of 16 colors to clips. Each clip can only have a single color assigned to it. Also, unlike flags, clip colors are clip-specific, so assigning a clip color to one use of a clip in the Timeline has no effect on any other clips that share the same source media in the Media Pool.

**Clip Color Appearance**

How these colors appear depends on the location of the clip. There are two options:

- Clip thumbnails in the Media Pool or the Thumbnail timeline of the Color page show a small colored dot at the upper-right-hand corner of the thumbnail.

- Clips in the Timeline are tinted everywhere but the thumbnail area of video clips. If you edit a clip into a track that has itself been colored, the clip color overrides the track color.
Assigning Clip Colors

Clip colors can be assigned in many different areas of DaVinci Resolve.

To assign a clip color to one or more clips, do one of the following:

- Use the Media page to assign clip colors to clips in the Media Pool using the Shot & Scene preset in the Metadata Editor. Clip colors do not appear in the Media Pool. Clip colors can be removed by clicking the X to the left of the Clip Color buttons in the Metadata Editor.
- Right-click one or more selected clips in the Timeline, and choose a color from the Clip Color submenu of the contextual menu. Clip colors can be removed by choosing Default Color from this same submenu.
- Colorists can right-click one or more selected clip thumbnails in the Color page and choose a color from the Clip Color submenu of the contextual menu. Clip colors can be removed by choosing Default Color from this same submenu.

Track Colors

Another method of visually organizing clips is the use of track colors. Each track can be color coded with one of 16 different colors. These color codes also appear in the Fairlight page, where they also correspond to the Edit page Mixer, and to the Fairlight page Mixer and Audio Meters.

To choose a new color for any track:

- Right-click the track header and choose a color from the Change Track Color submenu.
When you assign a color to a track, that track’s color appears in a thin strip to the left of that track’s header controls.

All clips that you place onto that track will appear with that color, unless they’ve been assigned an individual clip color, in which case the individual clip color overrides the track color. This makes track colors a great method of visual organization, because you don’t have to do any advance preparation; the very act of placing a clip on a specific track color codes it according to that track’s designated purpose.

Finding Clips, Media, Markers, Gaps, and Timelines

DaVinci Resolve has several methods of locating clips, markers, and gaps, to help you troubleshoot problem timelines, or to find media that you want to edit into a timeline differently.

Finding Clips in the Timeline

DaVinci Resolve makes it easy to find one or more clips in the Timeline that correspond to specific criteria using the Edit Index.
To find a clip in the Timeline:
1. Open the Edit Index.
2. Click the magnifying glass button to open the search controls.
3. Choose a criteria from the Filter By drop-down menu.
4. Type a search term in the Search field at the top right of the Edit Index.
   As soon as you start typing, all edit events that don’t match the search criteria are temporarily hidden. To show all of the clips in the Edit Index again, click the X at the right of the search field.
5. Click any event in the Edit Index to move the playhead to that clip in the Timeline.

Finding Offline Clips in the Timeline
It’s also easy to use the Edit Index to find all of the offline clips that may be in the Timeline.

To locate offline media in the current Timeline via the Edit Index:
1. Open the Edit Index.
2. Click the Option menu of the Edit Index and choose Show Offline Clips Only.
   The Edit Index is filtered to only show the offline clips in the currently open Timeline, and you can click any item on the list to jump the playhead to that particular clip in the Timeline.
3. Click any event in the Edit Index to move the playhead to that clip in the Timeline.

Finding Edit Index Events Using Clips in the Timeline
You can also locate specific Edit Index events using the Timeline playhead.

To locate a clip in the Edit Index from the Timeline:
– Move the Timeline playhead to intersect a clip you want to find in the Edit Index. That clip’s corresponding event (or events if the playhead intersects multiple clips) are automatically highlighted in the Edit Index.
– To move the playhead to a clip in the Timeline via the Edit Index.
– Click any event in the Edit Index to move the Timeline playhead to the In point of that clip.

Finding Clips
As you work, there are a variety of methods you can use to find clips in the Media Pool or your file system.

Methods of finding clips in the Media Pool or File System:
– To find a clip in the Media Pool: Open the Media Pool, and use the drop-down menu next to the Search button to choose whether to search through all bins in the current project, or just look at the currently selected bin or bins in the Bin List. If necessary, select the bin or bins that you want to search, and click the magnifying glass button to open the search controls. Optionally choose a criteria from the Filter By drop-down menu, then type a search term in the Search field. As soon as you start typing, all clips that don’t match the search criteria are temporarily hidden.
– To locate a Timeline clip in the Media Pool: Right-click any clip in the Timeline, and choose Find in Media Pool. That clip appears highlighted in the Media Pool.
– To locate a Source Viewer clip in the Media Pool: With any clip open in the Source Viewer, press Option-F.
To locate a media file in the Finder from the Media Pool: Right-click any clip in the Media Pool and choose Reveal in Finder. A Finder window, or its equivalent in Windows and Linux, opens to the directory with that clip, which appears highlighted.

To find the audio clip that a video clip has been synced to: Right-click a video clip that’s been synced to audio, and choose “Reveal synced audio in Media Pool” from the contextual menu. The bin holding the synced audio clip is opened and that clip is selected.

Finding Clips Using Markers or Flags
If you're using markers to keep track of notes, issues, or items on your to-do list, there are a few different ways of finding and moving among them.

Methods of finding markers or flags:

- To find all markers or flags via the Edit Index: Click the Option menu of the Edit Index and choose Show Markers or Show Flags. Each clip with one or more markers appears in a list, with columns corresponding to the color(s) and notes of each timeline and clip marker.

- To find a specific marker or flag in the Edit Index: Click the magnifying glass button in the Edit Index, choose Notes in the Filter by drop-down, and type a search term in the Search field.

- To move the playhead to the next marker forward or previous: Choose Playback > Previous Marker (Shift-Up Arrow) or Next Marker (Shift-Down Arrow).

Finding Gaps
Gaps, or spaces between two clips on the Timeline, appear by default as black. Unwanted gaps may appear as black flashes while your program plays back, and are generally to be avoided. DaVinci Resolve makes it easy to find gaps in specific tracks of your timeline.

To find gaps in the Timeline:
1. Make sure that the Auto Select control is enabled on any track you want to search for gaps. Turn Autoselect off on any tracks you don’t want to search for gaps (for example, title tracks where gaps are to be expected).

2. Do one of the following:
   - Choose Playback > Previous Gap or press Option-Command-Semicolon.
   - Choose Playback > Next Gap or press Option-Command-Apostrophe.

   The playhead will automatically move to the first frame of the next gap in the Timeline.

To delete gaps in the Timeline:
1. Make sure that the Auto Select control is enabled on any track you want to delete gaps. Turn Autoselect off on any tracks you don’t want to delete gaps (for example, title tracks where gaps are to be expected).

2. Choose Edit > Delete Gaps. If you want to limit the range of the deleted gaps this command respects both In/Out ranges and clip selections on the Timeline.

Finding the Currently Open Timeline in the Media Pool
If you’re not using one of the available methods for organizing timelines separately from clips, it can be easy to lose track of where your timeline happens to be. To find the currently open Timeline in the Media Pool, choose Timeline > Find Current Timeline in Media Pool.
Finding Media Using Match Frame Operations

Match frame operations are a terrific time saver when you need to match the original source clip to a clip in the Timeline, or when you want to use a clip in the Source Viewer to find that same clip in the Timeline. With a single command, you can match one clip to another in order to set up a new edit to take care of a variety of tasks.

Matching From the Timeline

A classic example of using Match Frame is when you originally edited a video clip into the Timeline without its corresponding audio, and you later decide you want that audio in the Timeline after all. An easy fix is to move the playhead in the Timeline to intersect the clip you need to fix, and use the Match Frame command to automatically load the original source media for that clip into the Source Viewer, setting Source In and Out points that match those of the Timeline clip, and putting the Source playhead at the same frame as the Timeline playhead. At that point, you can simply edit the source audio and video back into the Timeline to overwrite the video-only clip you started with, confident that you’re editing exactly the same range of media at the same place.

Using the pointer to Match Frame from the Timeline to find a source clip:

– Hold the Option key down and double-click the clip in the Timeline. The original source media for that clip is automatically loaded into the Source Viewer, with In and Out points that match those of the targeted Timeline clip; the Source playhead is at the same frame as the Timeline playhead.

Using keyboard shortcuts or Viewer controls to Match Frame from the Timeline to find a source clip:

1. Move the Timeline playhead to intersect the clip you want to target.

2. If there are other clips on a multi-track timeline that overlap the clip you’re targeting for this operation, then the clip on the highest video track will be used as the target for Match Frame operations. If you want to target a clip on a lower track, you can click on the specific clip under the playhead to highlight it. Alternatively you can disable the Auto Selection controls of all timelines above, or Option-click the Auto Selection control of the track with the clip you’re targeting to solo it.
3 Press the F key, or click the Match Frame button at the bottom right of the Timeline Viewer (it’s at the left of the In and Out buttons).

The frame that’s matched to the frame at the playhead in the Timeline; In and Out points are set to match those of the clip in the Timeline.

The original source media for that clip is automatically loaded into the Source Viewer, with In and Out points that match those of the targeted Timeline clip; the Source playhead is at the same frame as the Timeline playhead.

**Matching From a Source Clip**

Match Frame also works in the opposite direction. You can open a source clip into the Source Viewer that you know corresponds to a clip in the Timeline, and then you can use Match Frame to automatically find any clip in the Timeline that corresponds to media found within the source clip.

**To use Match Frame in the Source Viewer to find a clip in the Timeline:**

1. Open a clip in the Source Viewer that includes a range of media that’s already been edited into the Timeline. If no part of the source clip has been edited into the Timeline, source match framing won’t work.

2. Move the Source Viewer playhead to a frame that you want to find in the Timeline. Again, if the frame at the position of the playhead in the Source Viewer hasn’t already been edited into the Timeline, the Source Match Frame command won’t work.

3. Click the Match Frame button at the bottom right of the Source Viewer (it’s at the left of the In and Out buttons), or press the F key.

The Timeline playhead automatically moves to the clip and frame after the current playhead position that matches the clip in the Source Viewer.
Finding a Clip in the Media Pool
Using a Timeline Clip

There are two ways you can use a clip in the Timeline to find a clip in the Media Pool.

Using a Clip in the Source Viewer to Find a Media Pool Clip

To locate the original clip in the Media Pool that corresponds to a clip in the Timeline:

1. Open a Timeline clip into the Source Viewer by doing one of the following:
   – Double-click a clip in the Timeline.
   – Move the playhead to a clip in the Timeline, press Shift-V to select it, then press the Return key.

2. Press Option-F to locate the source clip corresponding to the clip that’s open in the Source Viewer in the Media Pool. That clip appears highlighted in the Media Pool.

Using a Clip in the Timeline to Find a Media Pool Clip

To locate a Timeline clip’s corresponding clip in the Media Pool, right-click any clip in the Timeline, and choose Find in Media Pool from the contextual menu. That clip appears highlighted in the Media Pool.

Tracking Media Usage

As clips are added to timelines, two mechanisms come into play for keeping track of which clips are used in which timelines.

Thumbnail Clip Usage Indicators

Whenever you open a timeline, all thumbnails in the Media Pool automatically update to show highlighted usage bars to let you know which parts of that clip are used in that timeline.

Two colored highlights at the bottom of the thumbnail indicate which parts of a clip are used by the currently open Timeline

If you right-click on a thumbnail that shows usage, a Usage submenu shows you a list of each instance of that clip in the currently open Timeline. Choosing an instance from this list jumps the playhead to that clip in the Timeline.
List View Clip Usage Column

A Usage column can be optionally shown in the Media Pool while in List view. By default, this column is empty, but if you right-click in the Media Pool and choose the Update Usage command, the project is analyzed, and every use of that clip in every timeline of the entire project is logged in this column.

NOTE: The usage column increments for each clip item that appears in the Timeline. This means that if a clip consists of one video item and one audio item linked together, the usage column will show the number 2.
If you’re working with media that was shot simultaneously using multiple cameras, then you can use the Multicam Editing tools in DaVinci Resolve to create multicam clips that can be edited using a visual switcher. Additional controls let you change the angles of multicam clips that have already been edited into the Timeline.

Contents

Introduction to Multicam Editing 719
Creating and Modifying Multicam Clips 719
Converting Compound Clips or Timelines to Multicam Clips 720
Logging and Editing Multicam Clips 721
Setting up a Timeline for Multicam Editing 721
Opening and Altering Multicam Clips 722
Performing a Multicam Edit 723
Multicam Controls in the Source Viewer 724
Multicam Keyboard Controls 725
Editing Multicam Clips in the Timeline 726
Grading Multicam Clips 727
Introduction to Multicam Editing

If you’re working on a program where a performance, interview, or event was recorded using multiple simultaneous cameras, DaVinci Resolve has multi-camera editing tools; multicam editing for short. Editing using these tools is a three part process:

– First, you have to create multicam clips from the individual camera angles (called “ISOs,” or isolated cameras).
– Second, you need to put the multicam clips you’ve created into a timeline.
– Third, you turn on the Multicam Viewer, and then you’re ready to start cutting and switching among angles, as if you were a live multi-camera director.

This section describes all of these steps, and the various options available for each of them.

Creating and Modifying Multicam Clips

Before you do anything else, you need to create one or more multicam clips.

To create a multicam clip:

1. Import all the ISO (isolated camera) clips that correspond to the multi-camera performance or event that you’ll be editing into the Media Pool.

2. Select all the clips that you need to sync together, right-click the selection, and choose “Create Multicam Clip Using Selected Clips.”

3. When the New Multicam Clip Properties dialog opens, choose from the following options:

   – **Start Timecode**: Presents the start timecode of the new multicam clip you’re about to create, which is determined by either the timecode value of the sync point if Angle Sync is defined by timecode, or by the sync point timecode value of the clip with the earliest timecode if Angle Sync is defined by waveform.

   – **Multicam Clip Name**: Use to choose a more descriptive name than “Multicam 1” for the multicam clip you’re about to create.

   – **Frame Rate**: Automatically lists the frame rate associated with the clips you selected.
– **Angle Sync:** The method used to synchronize all of the different angles. If you're manually syncing all of the angles, you can use In or Out points that you set within each clip. If matching timecode was jam synced to each camera recording an angle, you can choose Timecode for a fast sync that's as accurate as the timecode is. If each camera had a microphone with which to simultaneously record the location audio, you can choose Sound to use the shape of each audio waveform to align all of the angles.

– **Angle Name:** The method used to name each angle within the multicam clip being created. The angles can have Sequential numbering, use Angle or Camera metadata, or use the Clip or File name.

– **Detect clips from same camera:** Turning on this checkbox results in multiple clips that are identified as being from the same camera being put into the same angle track of the resulting multicam clip being created. It also enables the “Detect using” drop-down menu.

– **Detect Using:** The metadata used to determine which clips come from the same camera. You can choose from Camera #, Angle, Reel Number, Reel Name, and Roll/Card #, which are user-editable in the Metadata Editor of the Media page, or you can choose Reel Name which is automatically or manually derived using either the Conform Options of the General Options panel of the Project Settings, or the Name panel of the Clip Attributes window. For more information on the Conform Options, see Chapter 4, “System and User Preferences.”

– **Move Source Clips to “Original Clips” Bin:** A checkbox that lets you move all of the original ISO clips into an Original Clips bin to get them out of the way after the multicam clip has been created.

When you’re done choosing options, click Create. Depending on the Angle Sync method you chose, a waveform analysis might generate a progress bar, and then the new multicam clip is created in whichever bin is currently selected in the Media Pool. Multicam clips appear with a multicam badge in the lower left-hand corner of the clip thumbnail.

### Converting Compound Clips or Timelines to Multicam Clips

You can convert compound clips and timelines into multicam clips for easier editing using the Edit page’s Multicam Editing interface. This conversion is a one-way process. You cannot reconvert a multicam clip back to a timeline or compound clip. If you wish to preserve the original timeline or compound clip, make sure to duplicate it first, and then convert the copy.

**To convert a compound clip or timeline to a Multicam clip:**

– Right-click on the clip or timeline in the Media Pool and choose “Convert Compound Clips (Timelines) to Multicam Clips” from the drop down menu.
Logging and Editing Multicam Clips

Once you create one or more multicam clips, you can view them in the Media page or in the Source Viewer of the Edit page, and add markers to them (all angles share the same markers) to prepare for the multicam edit you’re planning on performing. When viewing multicam clips in the Media page, you can choose how many angles to show in the viewer via the Viewer Option menu.

![Markers set in a multicam clip in the Media page to prepare for editing](image)

Setting up a Timeline for Multicam Editing

Once you’ve created one or more multicam clips, preparing them for editing is as simple as editing them into the Timeline, either by dragging and dropping the multicam clip to the Timeline from the Media Pool, or by opening the multicam clip into the Source Viewer, and then using any of the available editing methods to cut it into the Timeline from there. Once edited, they appear in the Timeline like any other clip, just with a multicam badge to the left of the clip name.

![Multicam clip badge in the Timeline](image)

When you perform a multicam edit, DaVinci Resolve plays the entire audio mix while you’re editing, so if you want to take the opportunity to edit a master audio mix file or additional piece of music to play along with the multicam clip, you can do so.
Opening and Altering Multicam Clips

After you’ve created a multicam clip and put it into a timeline, you can modify it in a variety of ways by right-clicking it in the Media Pool and choosing “Open in Timeline.” This replaces the contents of the Timeline with a vertical stack of superimposed angles, one per track, each of which is offset from the beginning of the Timeline to align with one another.

With the multicam clip open, you can make a variety of changes in preparation for editing:

- You can slide a multicam clip left or right to alter its sync (selecting an angle and using the Period (.) and Comma (,) “nudge” keyboard shortcuts can be a good way of doing this).
- You can delete the track of an angle you don’t need (right-click the track header and choose Delete Track).
- You can rearrange tracks to rearrange the order in which angles appear (right-click any track header and choose Move Track Up or Move Track Down).
- You can rename tracks to change the angle name that appears by default in the Multicam Viewer and that will also appear in the Timeline when you do cut and switch editing.
- You can disable audio or video tracks that correspond to angles you don’t want to see, but don’t want to eliminate, either.
- You can grade each multicam angle separately (discussed later in this section).

When you’ve finished altering the contents of the multicam clip, you can close it using the path control at the bottom left-hand corner of the Timeline. Click the name of the edited timeline to go back, in preparation for the next steps.
Performing a Multicam Edit

After you’ve created one or more multicam clips and edited them into a timeline, actually executing a multicam edit is simple.

1. Open the Timeline you created to hold the multicam clip or clips comprising your edit, and position the playhead where you want to start editing.

2. Choose Multicam from the Source Viewer mode drop-down.

Switching the Source Viewer to Multicam viewing

The Source Viewer changes to display all of the different angles within that clip as switching controls.

3. Choose how many angles you want to display from the drop-down menu at the bottom right of the Source Viewer. If you’re using a computer that’s not very fast, you may need to reduce the number of angles you’re viewing to maintain real time playback.

Choosing how many angles to view in the Multicam Viewer

If there are more angles within the multicam clip intersecting the playhead in the Timeline than the Multicam Viewer is set to show, then page controls appear to the left of this drop-down menu that let you choose which set of angles you want to view. You can move to another page of angles by doing one of the following:

- Click any dot to jump to that page of angles.
- Click the arrows to move among next/previous sets of angles.
- Choose Edit > Multicam > Previous Page (Option-Shift-Left Arrow) or Next Page (Option-Shift-Right Arrow).

4. Choose whether you want to switch both the audio and video, just the video, or just the audio using the Audio/Video selection buttons at the bottom center of the Multicam Viewer. You can also choose Edit > Multicam > Video and Audio (Option-Shift-V), Video Only (Option-Shift-V), Audio Only (Option-Shift-A).

Buttons for choosing whether to switch the video, the audio, or both
5 Start playback, and while watching the program play, do one of the following:
   – Click any angle in the Multicam Viewer to insert a cut in the Timeline and switch to that angle. As you cut-and-switch, the cuts immediately appear in the Timeline while you play onward.
   – Option-click any angle to switch the angle used by the current clip without adding a cut. This is useful if you later regret the angle you cut to and just want to switch the entire segment since the last cut you made. This can also be accomplished by choosing Edit > Multicam > Previous Angle (Command-Shift-Left Arrow) or Next Angle (Command-Shift-Right Arrow).

As you play, the entire mix in the Timeline will play along with what you’re switching, so you can work in context.

6 When you’re ready to stop multicam editing, simply stop playback. If you want to start trimming the Timeline to fine-tune what you’ve done, choose Source from the Source Viewer mode drop-down, and you can re-edit and trim the multicam clips in the Timeline just like any others.

Multicam Controls in the Source Viewer

The Source Viewer, in Multicam mode, has four sets of controls that let you set up and execute multicam editing.
– **Multicam Angle buttons**: Each multicam angle displayed in the Source Viewer is a button that lists the angle name underneath. Clicking any of these buttons inserts a cut and switches the angle of the next clip, while Option-clicking changes the angle of the clip at the position of the playhead without adding a cut.

– **Audio/Video Selection buttons**: Clicking any of these buttons inserts a cut and switches the angle of the next clip, while Option-clicking changes the angle of the clip at the position of the playhead without adding a cut.

– **Multicam display drop-down**: Lets you choose how many angles to view while switching. Depending on your workstation’s performance, reducing the number of angles can improve playback performance while you edit. You can choose from a grid of 1x1, 1x2, 2x2, 3x3, or 4x4 angles to view.

– **Multicam Page buttons**: If there are more angles within the multicam clip intersecting the playhead in the Timeline than the Multicam Viewer is set to show (via the multicam display drop-down), then page controls appear that let you choose which set of angles you want to view. Click any dot to jump to that page of angles, or click the arrows to move among next/previous sets of angles.

**Multicam Keyboard Controls**

There’s also a full set of keyboard shortcuts that can be used for multicam editing.

– **Multicam Cut**: (Clip > Multicam Cut submenu) Pressing the 1 through 9 number keys performs a cut-and-switch operation, the same as if you’d clicked on an angle button of a multicam clip in the Source Viewer.

– **Multicam Switch**: (Clip > Multicam Switch submenu) Pressing Option-1 through 9 performs a switch operation, the same as if you’d Option-clicked an angle button of a multicam clip in the Source Viewer.

– **Previous/Next Angle**: (Edit > Multicam submenu) Pressing Command-Shift-Left or Right Arrow lets you switch to the previous or next angle. These controls will also loop back around to the first or last angles in the multicam clip.

– **Audio/Video Switching**: (Edit > Multicam submenu) Pressing Option-Shift-[ sets the Multicam Viewer to cut or switch both Video and Audio at the same time. Pressing Option-Shift-] sets the Multicam Viewer to cut or switch Video only. Pressing Option-Shift-\ sets the Multicam Viewer to cut or switch Audio only.

– **Previous/Next Page**: (Edit > Multicam submenu) Pressing Option-Shift-Left or Right Arrow lets you move to the previous or next page of multicam angles, if there are more angles than can be displayed in the Viewer’s current multi-angle setting.
Editing Multicam Clips in the Timeline

When it comes to editing and trimming, there’s no functional difference between multicam clips and any other kind of clip. Because you’re technically adding through edits to a single clip, you have the option or deleting any edit by selecting it and pressing the Delete key.

But multicam clips are special in that you always have the option of switching angles, either using the Multicam Viewer, or right in the Timeline via each clip’s contextual menu.

**To switch the angle of any multicam clip in the Timeline:**

- Right-click any clip and choose a new angle from the “Switch Multicam Clip Angle” submenu. This also allows you to change angles without needing to use the Multicam Viewer.

In the event that you want to eliminate all unused angles from a multicam clip and “flatten” it to simply be a single clip in the Timeline, there’s a command for that.

**To flatten a multicam clip in the Timeline:**

- Right-click any clip and choose Flatten Multicam Clip from the contextual menu. All unused angles are deleted, the clip becomes shorter if it included black tails because of another unused angle, and you end up with a single ordinary clip in the Timeline.

**To Match Frame to the angle of any multicam clip in the Timeline:**

- Place the playhead over the frame in the Timeline you want to match and press F. The exact frame of the multcam clip referenced will appear in the Source Viewer with the appropriate angle already selected.

**To Match Frame to the multicam clip in the Source Viewer:**

- Open the multicam clip in the Source Viewer. Navigate to the frame you want to find using the jog bar and press F. The playhead in the Timeline will move to the exact frame of the multicam clip referenced in the Source Viewer. If the frame you selected is not in the Timeline, when you press F nothing will happen.

**To edit an angle of any multicam clip directly from the Source Viewer:**

- You can click and drag any multicam angle directly from the Source Viewer to the Timeline. The length of the clip is bounded by the In and Out point selection of the clip.

Referencing a Line Cut

You may sometimes be provided with what’s called a “line cut” from a production. This is a pre-edited version of the program, cut live with the switcher and recorded during the performance or event, that’s meant to be used as a reference for what you’re doing. If you want to reference a line cut that’s been given to you as a movie file, you can add it as an Offline Reference Movie, and compare it to the Timeline using the Offline Reference Movie mode of the Source Viewer in the Edit page. For more information on using an Offline video to compare with a timeline in the Edit page, see Chapter 56, “Preparing Timelines for Import and Comparison.”
Grading Multicam Clips

Multicam clips appear like any other clip in the Color page. However, each angle within a multicam clip has its own grade (unlike the Take Selector described later, in which all takes share the same grade). If you grade a multicam clip, you’re actually editing the grade of the specific angle that’s currently exposed in that clip.

If you want access all of the angles within a multicam clip for grading, right-click it and choose “Open in Timeline” to expose each angle within a superimposed stack. Then you can open the Color page and grade whatever angles you want, whether they’re visible back in the Edit page or not. You might do this to make the different angles match one another better, or to pre-grade all of the angles to give them the look you want prior to multicam editing. You also need to use “Open in Timeline” in order to access and manipulate the camera RAW settings if your footage was shot in a RAW format.

An open multicam clip in the Color page exposes all of its angles for individual grading

Because opening multicam clips in the Timeline results in a vertical stack of superimposed clips, you’ll want to turn on Unmix in the Color page viewer so that you can actually see the currently selected angle in the Thumbnail Timeline while you work.

When you’re done grading the individual angles, go back to the Edit page, and use the path control at the bottom left-hand corner of the Timeline to return to your edited timeline.
Chapter 43

Take Selectors, Compound Clips, and Nested Timelines

This chapter covers a variety of different ways you can turn multiple clips into a single object in the Timeline, to accommodate a variety of different editing tasks. Take Selectors, compound clips, and nested timelines all appear as a single clip in the Timeline, but they all organize multiple clips in different ways. Take Selectors let you organize multiple clips vertically, making it easy to associate clips with one another so you can easily switch among them. Compound clips and nested timelines let you organize multiple clips horizontally, so that you can manage long or short sequences of clips within an edit as a single clip, when convenient.

Contents

Take Selectors 729
Compositing and Grading Take Selectors 730
Compound Clips 730
Compositing With and Grading Compound Clips 733
Nested Timelines 734
Re-Editing a Nested Timeline 734
Swapping the Contents of the Source Viewer and Timeline 735
Editing Source Media From a Timeline or Compound Clip 735
Marking Clips in Timelines Loaded into the Source Viewer 735
Decomposing Nested Timelines 735
Compositing and Grading Nested Timelines 736
Audio Buses in Nested Timelines 737
Converting Compound Clips or Timelines to Multicam Clips 737
Take Selectors

Take Selectors in DaVinci Resolve provide a way for you to manage multiple takes or versions of a particular clip in the Timeline. They’re ideal for storing multiple useful takes for scenes where you or the client can’t quite decide which one is the best, or for maintaining multiple versions of VFX clips that are going through different iterations.

When you place a number of clips inside a Take Selector, only one clip appears in the Timeline, but you can open that Take Selector and switch to any other take or version that’s stored within to switch which clip appears in the Timeline whenever you want.

Take selectors are easy to create and use and populate. Once you’ve placed a number of clips inside the Take Selector, you can drag any take to slip that clip’s range of media to synchronize it with the other takes, or click a take to choose that clip within the Take Selector to appear in the Timeline, before closing the Take Selector to confirm your change.

When closed, multi-take clips can be edited, trimmed, composited, graded, and rendered like any other single clip in the Timeline. A Take Selector badge appears to the left of the name of a clip to which it’s applied to show its status; double-clicking this badge opens the Take Selector so you can adjust its contents.
Methods of using Take Selectors:

- **To create a Take Selector:** Right-click any clip that’s not a title or generator, and choose Take Selector from the contextual menu. The Take Selector interface appears, disabling the rest of the Timeline temporarily while you work with the Take Selector’s contents.

- **To populate a Take Selector:** Drag any clip from the Media Pool into the Take Selector, and it appears “stacked” on top of the original clip in the Timeline.

- **To choose the current take:** Click any clip within the Take Selector so that it’s highlighted, and then click the close button at the upper-left corner of the Take Selector. When next you open the Take Selector, the current clip appears at the bottom of the stack, with a star at the upper-left corner. Absent a choice, the current take will default to the last clip added to the Take Selector.

- **To set a Take Selector to ripple the Timeline when a longer or shorter take is selected:** Click the Ripple Take button, at the upper right-hand corner of the Take Selector panel, to the left of the trash can button. With this turned on, selecting a take that's longer or shorter than the current take will ripple the Timeline. With this turned off, selecting a take that’s longer or shorter will either overwrite the next clip to the right, or leave a gap.

- **To slip a clip within the Take Selector:** Drag any clip to the left or right to slip the range of media that appears within the Take Selector’s duration in the Timeline. This is useful for synchronizing other takes to fit the same narrative beat as the first take you used.

- **To remove a clip from a Take Selector:** Click the clip you want to remove to select it, then click the trash can button at the upper-right corner of the Take Selector. That take disappears from the Take Selector.

- **To close a Take Selector:** Click the X close button, or press the escape key. Whichever take was selected is now the clip that appears in the Timeline.

- **To reopen a Take Selector:** Double-click the Take Selector badge at the left of a clip's name, or right-click a multi-take clip and choose Take Selector from the contextual menu.

- **To eliminate a Take Selector leaving only the take you want:** Close the Take Selector, if open, then right-click that clip in the Timeline and choose Finalize Take from the contextual menu.

Compositing and Grading Take Selectors

Since compound clips act like a single clip in the Timeline, they appear as a single MediaIn node in the Fusion page, and you grade them as you would any other single clip in the Color page. However, for Take Selectors, the composite or grade is applied to the Take Selector itself; when you switch to any other take, it appears with the same composition and grade.

**NOTE:** Any keyframing you do is relative to the Timeline of the overall Take Selector. This means that if you create a keyframed effect in either the Fusion or Color pages using take 1, and you then switch to takes 2, 3, or 4, the timing might not be exactly the same and you might need to make some adjustments.

Compound Clips

You can select a series of clips in the Timeline, be they edited one after the other in serial or superimposed and stacked in parallel, and turn them into a compound clip, which is a single clip in the Timeline that’s actually comprised of many other audio and video clips embedded inside. This allows you to work with a block of clips as if it were a single unit, governed by a single set of Inspector controls, and able to be connected to another clip in your timeline by a single transition.
Editing a compound clip works the same as editing any other type of clip. They can be edited, trimmed, and deleted using all the same methods. In addition, compound clips can be renamed, and decomposed back into their component clips right in the Timeline.

To create a compound clip by selection:

1. Select a range of clips.

2. Right-click one of the selected clips and choose New Compound Clip.

3. Enter an optional start timecode and a name, and click Create.

A compound clip is created which takes the place of the original clips you selected on the Timeline. Additionally, a copy of that compound clip appears in the currently selected bin of the Media Pool.
To create a compound clip by In-Out range:

1. Select a range of clips using In and Out points on the Timeline. This allows you to select partial sections of a clip to add to the compound, rather than the whole clip. All tracks between the In-Out range will be included, even if the track is disabled or auto select is off.

2. Right-click on the timeline range and choose Convert In and Out to Compound Clip.

3. Enter an optional start timecode and a name, and click Create.

Selecting a range of clips based on In and Out points to turn into a compound clip. Note that this selection includes only parts of the first and last clips in the range.

Right clicking on the In-Out range (gray bar) on the Timeline brings up the context menu.

Enter an optional start timecode and a name, and click Create.

The resulting bounds of the compound clip showing only the media included in the exact In-Out range.
To rename a compound clip:
– Click the name of the compound clip twice in the Media Pool to select the name text. Type a new name, and press the Return key to accept the change.

To edit a compound clip:
1. Right-click any compound clip and choose Open in Timeline from the contextual menu.
   The Timeline updates with the contents of the compound clip, which you can re-edit at your discretion.

2. To return to the original timeline when you’re finished, double-click the name of the enclosing timeline in the path control at the bottom left-hand corner of the Timeline.

To decompose a compound clip into its individual clips in the Timeline:
– Right-click any compound clip and choose Decompose in Place from the contextual menu. The compound clip is replaced by the individual clips it was made from.

To edit a compound clip from the Media Pool to the Timeline as individual clips:
1. Choose Edit > Decompose Compound Clips on Edit so the menu item is checked.
2. Use any editing command except for Fit to Fill or Place on Top to edit a compound clip from the Media Pool or Source Viewer to the Timeline to edit it as a sequence of individual, decomposed clips.

Compositing With and Grading Compound Clips
Since compound clips act like a single clip in the Timeline, they appear as a single MediaIn node in the Fusion page, and you can grade them as a single clip in the Color page. However, if you want to individually apply effects, adjust the RAW camera settings, or grade the original clips inside the compound clip, you can use the Open in Timeline command to access its constituent clips, and then open the Fusion or Color pages, where you’ll find each of the individual clips available for separate compositing or grading. When you’re done, go back to the Edit page and close the compound clip, and you’ll go back to seeing it as a single clip whenever you open the Fusion and Color pages.
Nested Timelines

Timelines, and sections of timelines, can be edited inside other timelines, either partially or whole. For example, if you’ve edited a program in scenes or reels such that each reel is contained in a separate timeline, you can edit all of the timelines together, one after the other, into a single timeline to assemble them into a final program.

![Multiple timelines edited together into a single sequence](image)

Nested timeline clips appear with a special badge to the left of the timeline name.

![The badge that indicates a nested timeline](image)

Timelines can be edited like any other clip, you can select one or more timelines and drag and drop them into another timeline, drag them onto the Timeline Viewer editing overlay, or use the toolbar editing buttons or keyboard shortcuts to edit them, just as you would any other clip.

Additionally, you can select multiple timelines in the Media Pool, right-click them, and choose Create Timeline Using Selected Clips to quickly assemble a group of timelines into a nested sequence.

The one exception is that you must drag and drop a timeline into the Viewer if you want to use it to set In and Out points, since double-clicking a timeline, or selecting a timeline and pressing Return simply opens it into the Timeline Editor. However, you can set In and Out points for timelines in the Filmstrip of the Media Pool, or you can edit a timeline into another timeline in its entirety, and then trim the head and tail down to just what you need. Double-clicking a nested timeline opens it into the Source Viewer for trimming, exactly like any other clip.

Re-Editing a Nested Timeline

If you want to edit the contents of a nested timeline, you can right-click it and choose Open in Timeline. Unlike compound clips, no path control appears when you do this, because you’ve simply opened the original timeline. To go back to the previous timeline, find and double-click it in the Media Pool, or choose it from the Timeline drop-down at the top of the Timeline Viewer.

Editing an original timeline does nothing to change the duration of nested instances of that timeline inside other timelines. If you trim or delete clips in the original timeline that appear in nested instances of that timeline, then those areas of the nested timeline simply go black.
Swapping the Contents of the Source Viewer and Timeline

When editing the partial contents of one timeline into another, it can be useful to see the contents of a timeline that’s open in the Source Viewer in the Timeline Editor. To do so, choose Timeline > Swap Timeline and Source Viewer (Command-Page Up). This puts the timeline that was open in the Source Viewer into the Timeline Editor, and the timeline that was in the Timeline Editor into the Source Viewer. This makes it easier to mark In and Out points while seeing the exact boundaries of clips, prior to pressing Command-Page Up to swap the contents of the Source Viewer and Timeline Editor once again in preparation for executing the next edit.

Editing Source Media From a Timeline or Compound Clip

If you have a timeline that has clips you want to edit into another timeline, but as source clips and not as nested timeline segments, you can turn on Edit > Decompose Compound Clips on Edit. This a mode determines whether a timeline is edited into another timeline as a nested timeline, or immediately decomposed into its constituent source clips. Turning this mode on lets you edit source clips from a timeline using drag and drop, 3-point edits, or whatever other method you find convenient. To go back to editing nested timelines, turn Edit > Decompose Compound Clips on Edit off. This mode is especially useful for workflows where you’re assembling “selects” timelines with the best moments of various interviews or performances, which you later want to edit as sources into the actual program you’re editing.

Marking Clips in Timelines Loaded into the Source Viewer

While you’re editing Source Media from a timeline that’s loaded into the Source Viewer, you can use the Mark Clip (the X key) to set Viewer In and Out points that match the start and end of whatever clip intersects the playhead within that timeline. This makes it easy to edit one clip from a Timeline in the Viewer into your program, all by itself.

Decomposing Nested Timelines

There are two main ways you can turn a nested timeline back into its constituent clips.

Decomposing in Place

To decompose a nested timeline that’s already been edited into another timeline, right-click it and choose Decompose in Place. You can also do this for multiple selected nested timelines, all at once.
If the decomposed clip has more audio or video tracks as a result, then additional tracks will be added to the Timeline to make room. If this is a problem, you can rearrange the clips.

Decomposing Nested Timelines While Editing

If you want to edit an entire timeline into another timeline solely as the source clips, you can turn on Edit > Decompose Compound Clips on Edit, and then edit that timeline into your program using whatever method you find convenient, as described previously in this chapter.

Compositing and Grading Nested Timelines

Similarly to compound clips, nested timelines act like a single clip in the Timeline; they appear as a single MediaIn node in the Fusion page for compositing, and you can grade them as a single clip in the Color page. However, if you want to individually add effects to or grade the original clips inside a nested timeline, you can either open that timeline from the Media Pool, or right-click that clip and choose Open in Timeline in order to access its constituent clips for compositing or grading.
Audio Buses in Nested Timelines
When you nest a timeline inside of another timeline that has buses set up for mixing in the Fairlight page, all Sub and Aux routings work as intended within the nested timeline, which exposes all channels of Main 1 in the enclosing timeline. In this sense, the audio of the nested timeline can be considered to be a submix that outputs its resulting audio to the audio track it’s edited onto. For more information about Buses and audio mixing in general, see Part 13, “Fairlight.”

Converting Compound Clips or Timelines to Multicam Clips
It’s possible to convert compound clips and timelines into multicam clips for easier editing using the Edit page’s Multicam Editing interface. This conversion is a one-way process. You cannot reconvert a multicam clip back to a timeline or compound clip. If you wish to preserve the original timeline or compound clip, make sure to duplicate it first, and then convert the copy. For more information, see Chapter 42 “Multicam Editing” in the DaVinci Resolve Reference Manual.

To convert a compound clip or timeline to a Multicam clip:
– Right-click on the clip or timeline in the Media Pool and choose “Convert Compound Clips (Timelines) to Multicam Clips” from the drop down menu.
Chapter 44

Trimming

Most editors would agree that trimming is half the job of editing. While you can make many kinds of changes in the Timeline using the selection and razor blade tools, there is a dedicated Trim mode in which you can perform more sophisticated trim operations in fewer steps using either the mouse or keyboard shortcuts, depending on how you like to work. Mastering DaVinci Resolve’s trimming operations will save you time when doing the necessary work of fine-tuning your edit.

Contents

Keyboard Shortcuts in This Chapter 739
Summarizing Trim Operations 740
Selection-Based Trimming Using the Trim Tool 740
How the Trim Tool Differs From the Selection Tool 741
Using the Trim Tool With the Mouse 742
Turning Off the Heads Up Display While You Trim 745
Trim Tool Operations With the Keyboard 746
Important Trimming Keyboard Shortcuts 746
Trimming Using Timecode Entry 748
How to Enter Timecode Values 748
Commands to Make Selections and Trim 749
Trimming Clips in the Source Viewer 750
Ripple Editing Rules 751
Using Auto Select Controls to Control Trimming 753
Using Auto Select to Control Which Clips Are Trimmed 753
Using Manual Selections to Control Which Clips Are Trimmed 754
Using Auto Select to Control Which Tracks Are Rippled 755
Trimming Multiple Edits or Clips at Once 757
Resizing and Rolling Multiple Edit Points 757
Rippling Multiple Edit Points 757
Asymmetric Trimming 759
Slipping Multiple Clips 761
Keyboard Shortcuts in This Chapter

Here's a list of of keyboard shortcuts you might find helpful that relate to topics found in this chapter.

<table>
<thead>
<tr>
<th>Key Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>T</td>
<td>Trim mode, ripples edits and slips or slides clips</td>
</tr>
<tr>
<td>A</td>
<td>Selection mode, resizes edits and moves clips</td>
</tr>
<tr>
<td>Command-L and J</td>
<td>“Fast trim” dynamically trims the selection at 100% forward and reverse speeds</td>
</tr>
<tr>
<td>W</td>
<td>Dynamic trim or resize mode, uses JKL to trim the selection</td>
</tr>
<tr>
<td>S</td>
<td>Toggles between Slip and Slide mode when a clip is selected in Trim mode</td>
</tr>
<tr>
<td>V</td>
<td>Selects the edit point closest to the playhead and moves the playhead there</td>
</tr>
<tr>
<td>Shift-V</td>
<td>Selects the clip or gap that intersects the playhead</td>
</tr>
<tr>
<td>Shift (modifier)</td>
<td>A modifier that temporarily disables the 2- and 4-up display that appears when trimming edits and clips with either the pointer or keyboard shortcuts.</td>
</tr>
<tr>
<td>Shift-Q</td>
<td>Toggles Enable Preview During Editing to control visibility of the 2- and 4-up displays</td>
</tr>
<tr>
<td>Option-F1 through F9</td>
<td>Toggles Auto Select for video tracks 1 through 9</td>
</tr>
<tr>
<td>Command-Option F1 through F9</td>
<td>Toggles Auto Select for audio tracks 1 through 9</td>
</tr>
<tr>
<td>U</td>
<td>Toggles edit point selection among the outgoing, centered, or incoming part of the edit</td>
</tr>
<tr>
<td>Comma, Period</td>
<td>“Nudge” keys to move a selected edit or clip left or right a frame at a time</td>
</tr>
<tr>
<td>Shift-Comma, Period</td>
<td>“Fast Nudge” keys to move a selected edit or clip left or right 5 frames at a time (customizable)</td>
</tr>
<tr>
<td>/</td>
<td>Play around current selection</td>
</tr>
<tr>
<td>Command-/</td>
<td>Toggles looped playback off and on</td>
</tr>
<tr>
<td>Down Arrow, Up Arrow</td>
<td>Moves both the playhead and selection to the next or previous edit point</td>
</tr>
<tr>
<td>E</td>
<td>Extend edit to resize or ripple selected edit points to the position of the playhead</td>
</tr>
<tr>
<td>Key Shortcut</td>
<td>Function</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Shift-Left, Right Bracket ([, ])</td>
<td>Trim Start to Playhead and Trim End to Playhead to trim a clip at the</td>
</tr>
<tr>
<td></td>
<td>position of the playhead and leave a gap (unless you’re in Trim mode so</td>
</tr>
<tr>
<td></td>
<td>the gap will be closed)</td>
</tr>
<tr>
<td>Shift-Command-Left, Right Bracket</td>
<td>Ripple Trim Start to Playhead and Ripple Trim End to Playhead to trim a</td>
</tr>
<tr>
<td>([, ])</td>
<td>clip at the position of the playhead and close the gap</td>
</tr>
<tr>
<td>Command-Shift-X</td>
<td>Ripple cut selection; close gap left by cut clip(s)</td>
</tr>
<tr>
<td>Command-C</td>
<td>Copy selected clips</td>
</tr>
<tr>
<td>Command-V</td>
<td>Paste clips</td>
</tr>
<tr>
<td>Command-Shift-V</td>
<td>Paste insert clips</td>
</tr>
</tbody>
</table>

**Summarizing Trim Operations**

Before going into the different methods of trimming that are available, users who are new to editing might benefit from a quick summary of what each trimming operation actually does. Each trim operation is designed to let you move edits and clips in relation to whichever clips are around them, by performing several operations at once. The five primary methods of trimming are:

- **Resize:** Shortens or lengthens the end of an outgoing clip or the beginning of an incoming clip, while either overwriting a neighboring clip or leaving a gap behind as necessary. While this isn’t usually included in a discussion of “trim” operations, it’s actually the simplest kind of trimming you can do.

- **Roll:** Moves an edit point to the left or right by either shortening the outgoing clip while lengthening the incoming clip, or vice versa. Roll edits do not change the duration of the overall Timeline.

- **Ripple:** Shortens or lengthens the end of an outgoing clip or the beginning of an incoming clip, while simultaneously moving all clips either to the right in the Timeline (if you’re rippling to lengthen a clip) or left in the Timeline (if you’re rippling to shorten a clip) to fill the gap or prevent overwriting that would otherwise occur if you were doing a resize operation. Ripple edits do change the duration of the overall Timeline and can alter the sync relation between different tracks if you’re not careful.

- **Slip:** Keeps a clip in the same place in the Timeline, while changing the range of media that appears in that spot. Slip edits do not change the duration of the overall Timeline.

- **Slide:** Keeps a clip’s range of media the same, but moves that clip to the left or right by either shortening the outgoing clip to its left while lengthening the incoming clip to its right, or vice versa.

**Selection-Based Trimming**

**Using the Trim Tool**

Trim mode differs from Selection mode in that operations that would move clips with the Selection tool will either slip or slide clips with the Trim tool. Other operations that would resize edits with the Selection tool instead ripple the Timeline to automatically close gaps when using the Trim tool. The following sections describe the various trim operations that are available, both when using the mouse, and when using the keyboard.
To enter Trim Edit mode:
– Click the Trim Edit button, or press the T key.

How the Trim Tool Differs From the Selection Tool

Aside from the actual trimming operations that are available, there are a few other important differences between the Trim tool and the Selection tool.

Selecting Edit Points

When the Trim tool is selected, dragging a bounding box over a series of clips in the Timeline selects the edit points to join clips together, instead of the clips themselves. This makes it fast and easy to select multiple edit points that you want to operate on simultaneously.

Selecting edit points in the Timeline using the Trim tool

Rippling the Timeline With Different Operations

When the Trim tool is selected, other commands and controls that would ordinarily resize a clip or clips and leave gaps in the Timeline instead move (ripple) clips that are to the right of the clip or edit you’re trimming over to the left to prevent gaps whenever clips or edits are moved or resized.

For example, the Retime controls, the Extend and Trim Start/End commands, and the Nudge keyboard shortcuts all work differently depending on whether you’re using the Selection or Trim tools. This lets you use one set of tools to do different operations, depending on what you need to do.

Rippling Gap

You can also use the Trim tool (or other trim operations described later in this chapter) to ripple the start and end of a gap in the Timeline. Rippling a gap lets you grow or shrink the gap while moving the portion of the Timeline to the right of the gap forward or backward in time. Whenever you ripple against gap, a 2-up display appears that lets you see both the clip you’re trimming and whatever superimposed clips may be showing through that gap.
Using the Trim Tool With the Mouse

When trimming using the mouse, you can perform every kind of trim operation that’s available using a single tool, simply by clicking the Trim mode/tool button, and then dragging on the appropriate area of a clip in the Timeline.

**Methods of trimming with the mouse in Trim Edit mode:**

– **To slip a clip:** To slip a clip’s range of content without changing its position in the Timeline, click the middle top region of a clip, and then drag to the left or right to “slip” the clip to contain a different range of frames. A dashed overlay shows the total duration of media available for you to slip with, which moves left and right as you drag.

When slipping clips, a 4-up display shows all relevant outgoing and incoming frames, so you can compare the continuity of action from one clip to the next. During a slip, the top two frames update to show you the new incoming and outgoing frames of the clip being slipped, relative to the unchanging outgoing frame of the clip to the left and incoming frame of the clip to the right.
**TIP:** You can temporarily disable this four-up display by pressing the Shift key while you slip so that you only see the frame at the position of the playhead. This makes it possible for you to see which frame passes the playhead by as you ripple the Timeline. You can toggle this two-up display off completely by selecting View > Enable Preview During Editing.

---

**To slide a clip:** To slide a clip, moving it to another position in the Timeline while simultaneously adjusting the Out point of the previous clip and the In point of the next clip to accommodate the change in position of the current clip being dragged, click the bottom-middle name bar of the clip and drag it to another position.

---

When sliding clips, a 4-up display shows all relevant outgoing and incoming frames, so you can compare the continuity of action from one clip to the next. During a slide, the bottom two frames update to show you the new outgoing frame of the clip to the left, and the new incoming frame of the clip to the right of the clip being slid.

**TIP:** You can temporarily disable this four-up display by pressing the Shift key while you slide so that you only see the frame at the position of the playhead. This makes it possible for you to see which frame passes the playhead by as you ripple the Timeline. You can toggle this two-up display off completely by choosing View > Enable Preview During Editing.
To roll an edit point: To roll an edit, moving the Out point of the outgoing clip and the In point of the incoming clip at the same time, drag an edit point between two clips to the left or right. (Roll edits can also be done in Selection mode.)

When rolling an edit, a 2-up display shows the changing continuity of action from the outgoing frame of the clip to the left to the incoming frame of the clip to the right, and you will hear the audio scrubbing of the right clip.
Ripple edit: To ripple the outgoing or incoming part of an edit to add or remove media to a clip while simultaneously moving all other clips at the left in the Timeline to make room, click the Trim tool, and drag an edit point to a new position in the Timeline.

When rippling an edit, a 2-up display shows the continuity of action from the outgoing frame of the clip to the left to the incoming frame of the clip to the right. Which frame updates depends on which side of the edit you’re rippling.

**TIP:** You can temporarily disable this two-up display by pressing the Shift key while you ripple so that you only see the frame at the position of the playhead. This makes it possible for you to see which frame passes the playhead by as you ripple the Timeline. You can toggle this two-up display off completely by selecting View > Enable Preview During Editing.

Turning Off the Heads Up Display While You Trim

If you press the Shift key while performing most drag and trim operations, you can suspend the multi-frame heads up displays that appear in the Timeline window in order to focus on the frame that intersects the playhead.

**To toggle the two- and four-frame heads up displays off or on:**

- Choose View > Enable Preview During Editing.
You can also perform every trim operation more precisely using the Nudge keyboard shortcuts.

To trim with the keyboard:

1. Press T to select the Trim tool.
2. To trim the selection, do one of the following:
   - **To slide a clip**: Press Shift-V to select a clip, and press the Comma key to slip it one frame to the left, or the Period to slip it one frame to the right. Shift-Comma and Shift-Period slips the clip in 5-frame increments.
   - **To slip a clip**: Press Shift-V to select a clip, then press the S key to toggle to Slip mode (pressing S again toggles back to Slide mode) and press Comma or Period to slide its contents to the left or right. Shift-Comma and Shift-Period slides the contents in 5-frame increments.
   - **To roll an edit**: Press V to select an edit point, then press the Comma key to nudge it one frame to the left, or the Period to nudge it one frame to the right. Shift-Comma and Shift-Period rolls the edit in 5-frame increments.
   - **To ripple an edit**: Press V to select an edit point, then press U to select either the incoming or outgoing side of the edit by itself. Then, press the Comma key to ripple the selected In or Out point of the clip to the left, or the Period to ripple it one frame to the right. Shift-Comma and Shift-Period ripples in 5-frame increments.

3. If you want to suspend the 2- or 4-up display that appears in the Timeline Viewer while trimming, you can choose View > Enable Preview During Editing to toggle the trimming displays off and on.

**TIP:** When holding down the Shift key while nudging to do a “fast nudge,” the duration of the nudge is customizable in the Editing panel of the User Preferences. By default it’s five frames, but you can set it to whatever you want.

### Important Trimming Keyboard Shortcuts

When trimming using the keyboard, the following keyboard shortcuts are important for you to remember. Most of these commands, and many more that haven’t been assigned to keyboard shortcuts, can also be found in the Trim menu. You can remap many of these commands to different keyboard shortcuts using the Keyboard Mapping panel of the User Preferences. For more information, see Chapter 4, “System and User Preferences.”

<table>
<thead>
<tr>
<th>Key Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>T</td>
<td>Trim mode, ripples edits and slips or slides clips.</td>
</tr>
<tr>
<td>A</td>
<td>Selection mode, resizes edits and moves clips.</td>
</tr>
<tr>
<td>Command-L and J</td>
<td>Fast trim commands, lets you dynamically trim the selection at 100% forward and reverse speeds.</td>
</tr>
<tr>
<td>W</td>
<td>Dynamic trim or resize mode, uses JKL to trim the selection.</td>
</tr>
<tr>
<td>S</td>
<td>Toggles between Slip and Slide mode when a clip is selected in Trim mode.</td>
</tr>
<tr>
<td>V</td>
<td>Selects the edit point closest to the playhead, and moves the playhead there.</td>
</tr>
<tr>
<td>Key Shortcut</td>
<td>Function</td>
</tr>
<tr>
<td>--------------</td>
<td>----------</td>
</tr>
<tr>
<td>Shift-V</td>
<td>Selects the clip or gap that intersects the playhead. If there are superimposed clips, turn off the Auto Select controls of tracks containing clips you don’t want to select.</td>
</tr>
<tr>
<td>Shift</td>
<td>A modifier that temporarily disables the 2- and 4-up display that appears when trimming edits and clips with either the pointer or keyboard shortcuts.</td>
</tr>
<tr>
<td>Option-F1 through F9</td>
<td>Toggles Auto Select for video tracks 1 through 9, making it possible to restrict certain selection and trim operations performed with the keyboard.</td>
</tr>
<tr>
<td>Command-Option F1 through F9</td>
<td>Toggles Auto Select for audio tracks 1 through 9, making it possible to restrict certain selection and trim operations performed with the keyboard.</td>
</tr>
<tr>
<td>U</td>
<td>Toggles the currently selected edit point among the outgoing, centered, or incoming part of the edit.</td>
</tr>
<tr>
<td>Option-U</td>
<td>Toggles the currently selected edit point or clip among Video+Audio, Video Only, or Audio Only.</td>
</tr>
<tr>
<td>Comma (,)</td>
<td>After you’ve made a selection, nudges selected edits or clips one frame to the left. Shift-Comma nudges 5 frames (the duration is customizable in the Editing panel of the User Preferences).</td>
</tr>
<tr>
<td>Period (.)</td>
<td>After you’ve made a selection, nudges selected edits or clips one frame to the right. Shift-Period nudges 5 frames (the duration is customizable in the Editing panel of the User Preferences).</td>
</tr>
<tr>
<td>Forward-Slash (/)</td>
<td>This command works contextually depending on what’s selected in the Timeline. Plays a section of the Timeline from x frames before to y frames after (a) the playhead (if nothing’s selected), (b) the currently selected edit point, (c) the currently selected clip, (d) a selection of multiple clips. This command is useful for previewing how the current selection plays within the context of the clips immediately surrounding it. The pre-roll and post-roll time is customizable in the Editing panel of the User Preferences.</td>
</tr>
<tr>
<td>Command-/</td>
<td>Toggles looped playback off and on.</td>
</tr>
<tr>
<td>Down Arrow, Up Arrow</td>
<td>Moves both the playhead and selection state to the next or previous edit point. If multiple clips or edits are superimposed, the first clip on the lowest numbered track will be selected first, then the next clip up, and so on until the topmost superimposed clip is selected, before selecting the next clip in the Timeline.</td>
</tr>
<tr>
<td>E</td>
<td>Extend edit. Resizes or ripples selected edit points to the current position of the playhead.</td>
</tr>
<tr>
<td>Shift-[</td>
<td>Trim Start. Resizes (Selection) or ripples (Trim) the In point of all clips on auto-select-enabled tracks that intersect the playhead to the position of the playhead.</td>
</tr>
<tr>
<td>Shift-]</td>
<td>Trim End. Resizes (Selection) or ripples (Trim) the Out point of all clips on auto-select-enabled tracks that intersect the playhead to the position of the playhead.</td>
</tr>
<tr>
<td>Shift-Command-[</td>
<td>Ripple Trim Start. Regardless of whether Selection or Trim mode is enabled, always ripples the In point of clips on auto-select-enabled tracks that intersect the playhead to the position of the playhead.</td>
</tr>
<tr>
<td>Shift-Command-]</td>
<td>Ripple Trim End. Regardless of whether Selection or Trim mode is enabled, always ripples the Out point of clips on auto-select-enabled tracks that intersect the playhead to the position of the playhead.</td>
</tr>
</tbody>
</table>
IMPORTANT

While the Slip, Roll, and Slide tools will change the sync relationship of the clips you’re adjusting with a matching soundtrack, the rest of the Timeline won’t be affected. Using Ripple can alter the overall sync relationship of large portions of your timeline and its matching soundtrack, so you should use it with extreme care.

Trimming Using Timecode Entry

You can also use absolute or relative timecode entry to trim clips and edits. What is trimmed depends on the selection you’ve made prior to entering timecode. If you want to use timecode to trim the selection forward relative to its current position, be sure to type an equal sign or plus (= or +) before the timecode value; to trim the selection backward relatively, type minus (–) before the timecode value.

- To roll an edit: Select the center of an edit point, enter a timecode value, and press Return.
- To ripple an edit: Select either the outgoing or incoming half of an edit point, enter a timecode value, and press Return.
- To slip a clip: Select a clip, and press S if necessary to switch to Slip mode, enter a timecode value, and press Return.
- To slide a clip: Select a clip, and press S if necessary to toggle to Slide mode, enter a timecode value, and press Return.

How to Enter Timecode Values

When entering timecode, type each pair of hour, minute, second, and frame values from left to right, with a period representing a pair of zeros for fast entry. The numbers you enter appear in the Timecode field at the upper left-hand corner of the Viewer with focus. When you’re finished typing, press the Return key to execute the Timecode command. The rules for timecode entry are as follows:

- The rightmost pair of timecode values (or period) you enter is always the frame number.
- A period to the left or to the right of any number you type is considered to be a pair of zeroes.
- A single period between two numbers is considered to either be a single zero or ignored if it’s between two pairs of numbers.
- Any untyped pairs of values to the left of what you enter are assumed to be whatever those values were prior to the timecode you entered; this makes it easy to type partial timecode values even when the Timeline starts at hour one.
- It’s not necessary to enter colons or semicolons.

Absolute timecode is entered simply by typing in a timecode value. So long as no clips or edit points are selected when you press the Return key, the playhead will move to that timecode value. If an edit point or clip is selected, those will be moved or trimmed to the corresponding timecode value, if possible.
Here are some examples of absolute timecode entry using this method:

<table>
<thead>
<tr>
<th>Original TC Value</th>
<th>User-Typed Value</th>
<th>New TC Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>01:10:10:10</td>
<td>15245218</td>
<td>15:24:52:18</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>2..</td>
<td>01:02:00:00</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>15</td>
<td>01:10:10:15</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>12</td>
<td>01:10:10:12</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>1.2</td>
<td>01:10:01:02</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>115..</td>
<td>01:15:00:00</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>23...</td>
<td>23:00:00:00</td>
</tr>
</tbody>
</table>

Relative timecode is entered by starting the timecode value with a plus (+) or minus (–). Adding a plus results in the value you type being added to the current timecode value for purposes of offsetting the playhead or moving a selection. Adding a minus will subtract the value you type from the current timecode value.

Here are two examples of relative timecode entry:

+20. 00:00:20:00 is added to the current timecode value.

-5 00:00:00:05 is subtracted from the current timecode value.

## Commands to Make Selections and Trim

A series of commands in the Trim menu make it fast to automatically select the In or Out point of the clip that’s nearest to the current position of the playhead, and go into either Selection or Trim mode in preparation for resizing or ripple trimming that edit point. These commands are:

- Select Nearest Edit to Resize In
- Select Nearest Edit to Resize Out
- Select Nearest Edit to Ripple In
- Select Nearest Edit to Ripple Out
- Select Nearest Edit to Roll
- Select Nearest Clip to Move
- Select Nearest Clip to Slip
- Select Nearest Clip to Slide

These commands are similar to using the Edit Selection (V) or Clip Selection (Shift-V) keyboard shortcuts along with those for choosing the Selection (A) or Trim tool (T) both at once, to get you ready for trimming in the way that you want. However, they have the added benefit of, in some cases, letting you specifically choose the In or Out points of the clip nearest the current position of the playhead. These commands don’t have keyboard shortcuts by default, but if you prefer this way of working, you can assign them to keyboard shortcuts of your choosing using the Keyboard Customization tool (Option - Command - K).
Trimming Clips in the Source Viewer

Additionally, you can double-click a clip in the Timeline to open it into the Source Viewer for trimming. When the Selection tool is selected, you can drag the In and Out markers, or use the playhead and I and O keyboard shortcuts to resize that clip in the Timeline. With the Trim tool selected, you can ripple the In and Out points of the clip.
You can slip the contents of the clip by holding the Shift key down and dragging either the In or Out point.

A Timeline clip being slipped by opening it into the Source Viewer and Shift-dragging its In point using the Trim tool

**NOTE:** To open a match frame of a clip that’s part of an edited sequence into the Source Viewer using the mouse, hold the Option key down while double-clicking a clip in the Timeline.

### Ripple Editing Rules

Ripple operations are the only trim functions that change the duration of the overall Timeline, and that can potentially alter the sync relationship between multiple clips on different tracks. This makes them incredibly useful, but it’s important to understand which parts of the Timeline will move as part of a ripple operation, and which parts won’t.

The following operations ripple the Timeline:

- Ripple deleting a clip or gap (Forward-Delete)
- Ripple cutting a clip (Shift-Command-X)
- Rippling one or more edits or gaps using the Trim tool (press T to choose the Trim tool)
- Using the Extend Edit (E), Trim Start (Shift-[, or Trim End (Shift-]) commands in Trim mode
- Using the Ripple Start (Command-Shift-[) or Ripple End (Command-Shift-]) commands in any mode
- Performing an insert edit (F9) or ripple overwrite edit (Shift-F10)
- Using the Retime controls to speed up or slow down a clip in Trim mode
- Using the Change Speed dialog with the Ripple Sequence checkbox turned on
- Changing clips in a Take Selector with the Ripple control enabled

During a ripple edit, superimposed clips with an In point that’s to the left of the edit point or clip being rippled are not moved. This can be seen in the previous example via the audio clip at the bottom of the Timeline, which stays in place even as the clips on track V1 and A1 are rippled. All clips with In points to the right of the edit point or clip being rippled move left to follow the trim operation you’re making.
The rules of timeline rippling illustrated. All clips with In points to the left of Subclip B (the clip being rippled) are left in place (area in blue), while all clips to the right of the edit being rippled are moved by the duration of the ripple operation (in red).
This simple rule means that, if you’re in the habit of building sequences of clips from left to right, long overlapping superimpositions such as titles, graphics, and music clips will stay in place while you’re rippling various clips within a montage that you’re editing in relation to these longer clips.

However, there’s one exception to this rule. It is often the case that split edits, where linked audio and video are cut at different places, create a situation where the audio In point of a pair of linked audio and video items precedes a video In point that you want to ripple. In other words, the audio In point extends to the left of the video In point, which ordinarily would trigger the rule that clips with edit points to the left of a rippled edit point won’t be moved, which would throw the audio and video of this item out of sync. In this case, you probably want to maintain sync, so all items that are linked to a clip being ripped always ripple along with it, even if they do have In points that extend to the left of the edit point being rippled.

**Using Auto Select Controls to Control Trimming**

The Auto Select buttons on each track in the Timeline control a host of different operations, but while they’re deceptively powerful, they’re also among the most misunderstood controls of the Timeline. When a track’s Auto Select control is on, clips on that track are automatically included in three different types of operations:

- Operations that affect clips intersecting the position of the playhead
- Operations that affect clips intersecting a region defined by timeline In and Out points
- Operations that ripple clips to the right of an affected clip on the Timeline

When a track’s Auto Select control is off, clips on that track are ignored by those same categories of operations, unless you manually select one or more clips or edit points.

The next three sections go into detail on how the Auto Select buttons help you control the trimming operations described in this chapter, particularly when it comes to operations that ripple the Timeline, and the kinds of “playhead-targeted” trim operations described later in this chapter. For more information on using the Auto Select controls to define selections and control other editing operations, see Chapter 37, “Editing Basics.”

**Using Auto Select to Control Which Clips Are Trimmed**

One of the principal uses of the Auto Select controls is to let keyboard shortcut-driven editors choose which specific clips on which tracks will be affected by an operation that would otherwise affect every superimposed clip at the position of the playhead or encompassed by In and Out points set in the timeline.

For example, if multiple clips are superimposed in V1, V2, and V3, and A1, A2, and A3, all six tracks have their Auto Select controls turned on, and you park the playhead over one of them and use the Trim End command in Selection mode, then all six superimposed clips will be trimmed.
Trimming all clips at the position of the playhead

However, if you only want to trim the clip in track V3, then you can solo the Auto Select control of V3 by Option-clicking it, and then when you use the Trim End command, the clip on V3 is the only one that’s trimmed, the other clips are ignored.

Trimming only the clip in V3 by soloing the V3 Auto Select controls

Using Manual Selections to Control Which Clips Are Trimmed

It’s important to know that manual selections you make in the Timeline that highlight specific clips always take precedence over whatever the Auto Select controls are set to. For example, if Auto Select is turned on for tracks V1, V2, and V3, but you’ve selected a clip on track V1, only the selected clip will be still be affected by whatever operation you decide to perform. For example, if you use Trim End, the clip on track V1 will be affected.
Using Auto Select to Control Which Tracks Are Rippled

Each track’s Auto Select control is also used to control how trimming and editing operations that ripple the Timeline affect timelines with multiple tracks and superimposed clips. Using Auto Select controls, you can turn off rippling on specific tracks, while leaving it on for others.

For ease of use, you’ll typically want to leave Auto Select on for all tracks when rippling clips, to ensure that all the parts of your timeline stay in sync with one another. However, when the occasion requires, the Auto Select controls provide the option to suspend rippling on specific tracks while allowing rippling on others.

The rules are simple:

- **Tracks with Auto Select enabled**: Ripple editing or ripple deleting affects all clips to the right of the clip or clips on that track being trimmed.
Tracks with Auto Select disabled: Rippling is disabled on these tracks.

Before and After, clip to the right of Clip T on tracks V1 and A1 are rippling because those tracks’ Auto Select controls are enabled, but clips on tracks V2 and A2 aren’t rippling because those tracks’ Auto Select controls are disabled.

Another set of rules govern what happens when you select clips or edits for trimming on tracks with Auto Select disabled:

– **Selected Tracks with Auto Select turned off with an edit selection:** If you select the outgoing or incoming half of an edit on a track that has Auto Select off, the result will be a resize operation. Ripple deleting clips leaves a gap.
Trimming Multiple Edits or Clips at Once

DaVinci Resolve lets you select multiple edit points or clips for certain trimming operations, making it possible to trim multiple edits and clips at the same time. In simple cases, this makes it easy to resize, ripple, slip, and slide several superimposed clips at the same time, which is a real convenience, or you can select the In point of every title generator in a credit sequence at once in preparation for shortening or lengthening them all at once. In more complicated cases, this lets you create more complicated trimming scenarios, such as multi-track asymmetric trimming, to quickly take care of difficult tasks.

No matter how ambitious a trim operation you want to set up, the procedure is exactly the same as for an ordinary trim operation. Just make sure you follow these three general steps, and you’ll be good:

1. Choose Selection mode, and select the edit points or clips you want to trim. To make multiple selections, click once to select the first item, then Command-click each subsequent item you want to add to the selection. You can select as many clips and/or edit points on as many tracks as you like.

2. To ripple, slip, or slide the entire selection at once, choose Trim mode. To resize or move each selected item at once, continue using Selection mode.

3. Use the mouse, keyboard shortcuts, or timecode entry to execute the trimming operation, just as you would if a single edit point or clip were selected.

The following sections describe each of the special-case multi-selection trim operations that are possible, along with each one’s special rules and limitations.

Resizing and Rolling Multiple Edit Points

You can resize or roll multiple edit selections at once. In this way, you can adjust the edit points of multiple superimposed clips all together. Trimming multiple edit points essentially lets you “gang” them so that all selected edits move together as one.

– To resize multiple clips at once, select the left (outgoing) or right (incoming) half of each edit point you need to adjust, then use the Selection tool to drag those edit points to resize them all.

– To roll multiple clips at once, select every edit point you need to adjust right at the center, so that both the incoming and outgoing halves of each edit point are selected, then use either the Selection or Trim tools to drag those edit points to roll them all.

NOTE: You cannot combine ripple and roll operations at the same time.

Rippling Multiple Edit Points

It’s also possible to select multiple incoming or outgoing edit points on either superimposed video tracks, or on the same video track, in order to ripple them all at once. A good example of when you’d want to ripple multiple clips on the same track is if you’ve got an end credit sequence of 14 text generators, and you’d like to shorten the entire sequence by a particular amount. This example can be seen below.

When you ripple trim multiple edits on the same track, how many frames are trimmed in a particular trim depends on what method you use to do your trimming.
– If you use the Trim tool via dragging in the Timeline, then you can choose to ripple the entire selection of edits by an arbitrary duration, for example, shortening or lengthening the entire selection by eight frames. To do this, DaVinci Resolve performs your multi-selection trim operation one edit at a time, removing a frame at a time from each selected edit from the left to the right as you trim, until either you stop the operation, or every single selected edit has had a frame removed, at which point DaVinci Resolve begins trimming the second frame from each selected edit from the left to the right, and then the third, and so on, until you stop trimming. Working this way, you can use the mouse to trim any number of clips to fit into any duration.

– You can also choose to ripple each selected edit by the same amount, for example removing three frames from each of the selected edits, all at once. To do so, hold the Command key down while dragging selected edits with the Trim tool, or use Dynamic JKL trimming, or trim by entering relative timecode values, or use the nudge keys (Period and Comma).

**To ripple trim multiple edits on the same track:**

1. Click the Trim tool, and drag a bounding box in the Timeline to select all 14 edits.
2. Press the U key to select the incoming half of each selected edit.
3. Use whichever trimming method you prefer to ripple the sequence to be shorter or longer. Dragging using the Trim tool lets you trim by an arbitrary number of frames, while holding the Command key down while dragging with the Trim tool, using timecode entry to trim, using the Comma and Period nudge keys, or using Dynamic JKL trimming lets you trim every selected edit by the same number of frames.

In the following example, the incoming edit of three clips in the following montage are selected and simultaneously rippled using the Trim tool. Notice that each overlapping clip ripples along with the nearest selected edit that’s to the left of it; this means that the superimposed clip in track V2 and the audio clip in track A4 ripples along with the third selected edit, while the audio clip in track A2 ripples along with the second selected edit. Since the audio clip in track A3 starts to the left of the first selected edit, it does not ripple.
Asymmetric Trimming

Asymmetric resize or ripple trimming can also be done to multiple clips, with one selection per track allowable on as many tracks as you require. To asymmetrically trim two or more clips, select an outgoing edit point on one track, and then Command-click an incoming edit on another track.

Selecting opposite outgoing video and incoming audio edit points in preparation for performing an asymmetric ripple trim

To select the outgoing video edit of one clips and the incoming audio edit of the next clip in preparation for making a split edit, you can Option-click the outgoing video edit to suspend linked selection, and then Command-click the incoming audio edit to add it individually to the selection. Now when you drag, nudge, or use timecode to trim, each selected edit point will move in the opposite direction.

Dragging to perform an asymmetric ripple trim to create a split edit using the Trim tool

DaVinci Resolve allows you to do asymmetric trims to multiple edits in the same video and/or audio track. There are two compelling reasons for doing so:
Select the outgoing half of an edit point (the left side), then Command-click to select the incoming half of the same edit point (the right side) separately. This will not perform a roll edit, but will allow you to either use the Selection tool to resize both edit points away from each other to create a gap, or use the Trim tool to ripple both sides of the edit to shorten both clips while tightening up the Timeline at the same time.

Before and After ripple trimming both the incoming and outgoing halves of an edit to shorten the duration of both clips at once

You can also select the In and Out points of a clip in the Timeline at the same time, and use the Trim tool to ripple both the beginning and end of the clip closer to the center, shortening the clip while preserving the content in the middle, while tightening up the Timeline.

Before and After ripple trimming both the In and Out points of a clip at the same time, shortening the clip by removing heads and tails, and preserving the action in the middle
In short, you can use nearly any combination of edit selections you need to simultaneously trim multiple clips in the same track, in multiple tracks, whatever you need to do to save time. Furthermore, asymmetric trimming can be done in either Selection or Trim mode, either to open and close gaps, or to move edit points to overlap one another to create split edits.

**Slipping Multiple Clips**

You can simultaneously slip any number of selected clips (so long as they have handles) on any combination of tracks by selecting the clips you want to slip, then choosing the Trim tool, and dragging their name bars or using the Comma and Period keys to nudge the selection.

![Dragging to slip multiple selected clips at once](image)

**Sliding Multiple Clips**

You can select as many clips as you like in preparation for a slide operation. If you select multiple contiguous clips, they slide together as one.

![Before selecting four clips to slide, After all four clips slid to the right using the mouse](image)
Keyboard Trimming During Looped Playback

A great technique for editors who like to do precision trimming using the Nudge commands is the ability to enable looped-playback so that the Play Around command (Forward Slash) will loop continuously around the edit point you’re trimming as you nudge one or five frames at a time to fine-tune the cut.

**To trim while looping:**

1. Move the playhead near the edit point you want to trim, and press V to select it.
2. Press the U to choose which side of the edit you want to select in order to ripple or roll it, and/or Option-U to choose whether you want to trim video+audio, the video only, or the audio only.
3. Press Command-Forward Slash (/) to enable looped playback.
4. Press Forward Slash (/) to play around the current selection. With looping on, playback will continue until you stop it. Pre-roll and post-roll can be changed in the Edit panel of the User Preferences.
5. During looped playback, press the Comma (,) and Period (.) keys to trim the selection back or forward by a single frame, or Shift-Comma and Shift-Period to trim the selection in 5-frame increments. If you do this during the post-roll of looped playback, the loop immediately replays from the beginning so you waste no time seeing the result.
6. When you’re finished, press the Spacebar or K key to stop playback.

**TIP:** When holding down the Shift key while nudging to do a “fast nudge,” the duration of the nudge is customizable in the Editing panel of the User Preferences. By default it’s five frames, but you can set it to whatever you want.

Dynamic JKL Trimming

One of DaVinci Resolve’s most interactive trimming features is the ability to dynamically resize, ripple, roll, slip, slide, or move selected edit points and clips using the JKL transport control keyboard shortcuts. This means that you can make an appropriate selection in the Timeline (edit points to resize, ripple, or roll, or clips to slip or slide) then trim them during playback, while monitoring audio and watching the video.

Trimming while viewing the selected clip or edit point playing back has the advantage of letting you get emotionally involved in what you’re watching, as well as experiencing the timing of a clip as it plays, in order to help you get a better feel for how, exactly, you need to trim a particular cut.

While you’re dynamically trimming, you see the same two-up or four-up display, the same Timeline overlays, and the same dynamically updating Timeline that appear when you use the Trim tool with the mouse. The only difference is that you’re trimming while your program plays.

There are two methods of doing dynamic trimming:

– **Quick Trim:** You can select one or more edit points or clips, and immediately trim it by pressing Command-J or Command-L to trim back or trim forward. This is a fast way of dynamically trimming, but you can only trim forward and backward at 100 percent speed or greater.

– **Turning on Dynamic mode:** If you want to do more detailed work, you can press the W key to enable Dynamic mode (or choose Trim > Dynamic Trim Mode), at which point you are in a special mode where the JKL shortcuts only trim the current selection, whatever it happens to be. However, this mode also gives you additional options for controlling which part of the selection, in the case of multiple selection trims, you want to monitor for audio/video playback.
Quick Trimming

If you’re in a hurry and you can accomplish the trim you want via real time or faster playback, then pressing the Command key while using the J or L keyboard shortcuts lets you dynamically trim any selection in the Timeline, with audio/video playback.

To dynamically trim using Command-J or Command-L:

– To dynamically roll an edit: In either Selection or Trim mode, select the center of one or more edit points, and hold the Command key down while using J or L to move the selection around.

– To dynamically ripple an edit: Choose Trim mode, select the outgoing or incoming half of one or more edit points, and hold the Command key down while using J or L to move the selection around.

– To dynamically resize an edit: Choose Selection mode, select the outgoing or incoming half of one or more edit points, and hold the Command key down while using J or L to move the selection around.

– To dynamically move a clip: Choose Selection mode, select one or more clips, and hold the Command key down while using J or L to move the selection around.

– To dynamically slip or slide a clip: Choose Trim mode, select one or more clips to slip, or a single clip to slide, press S to toggle between Slip or Slide modes, then hold the Command key down while using J or L to execute either slip or slide operations.

If you’re trimming multiple selections, you can control which edit point you monitor during the trim operation by positioning the playhead at one of the selected edit points.

TIP: When you’re finished with a “quick trim” operation and you want to see how that edit plays, you can press the Forward Slash key (/) to play around the current selection to quickly preview that section of the Timeline.

Dynamic Trimming (or “JKL Trimming”)

If you want to also have the option of trimming using the JKL shortcut keys in slow motion or frame by frame, in addition to trimming at 100% or greater playback speeds, then you’ll need to enable Dynamic Trim mode.

To use Dynamic mode to dynamically trim one or more selected clips or edits:

1 It’s not necessary to make a selection prior to enabling Dynamic mode for trimming, since the act of entering Dynamic mode automatically selects the closest edit point to the playhead. However, if you want to use Dynamic mode to make a complex trim operation, you can select any combination of edit points to resize, ripple, or roll, or you can select one or more clips that you want to slip or slide (using the S key to toggle between slipping and sliding).

2 Press W to enter Dynamic mode, or click the Dynamic tool in the toolbar. If nothing is selected in the Timeline, then the edit point that’s nearest to the playhead will be automatically selected. If you’ve already made a selection, that selection will remain and be used for trimming.

Once you’ve entered Dynamic mode, the Dynamic Trim tool in the toolbar turns yellow to let you know that you’re in Dynamic mode, and the icon shows you whether you’re in Slip or Slide mode.
for trimming. Additionally, the playhead turns yellow to serve as a constant reminder that you’re in Dynamic mode, in which all you can do is trim clips.

3. Choose the type of operation you want to perform by clicking either the Selection tool (or pressing A) or the Trim tool (or pressing T):

   **In Selection mode:**
   - You can dynamically resize or roll edits if you’ve selected one or more edit points in the Timeline.
   - You can move or slip clips if you’ve selected one or more clips in the Timeline. You can choose whether to move or slip selected clips by pressing the S key, or by right-clicking the Dynamic trim tool in the toolbar and choosing Slip or Slide from the drop-down menu.

   **In Trim mode:**
   - You can dynamically ripple or roll edits if you’ve selected one or more clips in the Timeline.
   - You can slide or slip clips if you’ve selected one or more clips in the Timeline. You can choose whether to slide or slip selected clips by pressing the S key, or by right-clicking the Dynamic trim tool in the toolbar and choosing Slip or Slide from the drop-down menu.

4. If you’ve selected multiple edit points or clips, then you can use the Left and Right arrow keys in Dynamic mode to move the playhead to the selected edit point you want to monitor while you’re trimming. If the playhead isn’t aligned with a selected edit point, then it will jump to the nearest selected edit point once trimming commences.

5. Use any combination of the JKL keyboard shortcuts to initiate playback and trimming, including:
   - J+K or K+L to trim in slow motion, with slow motion audio playback
   - Pressing K while tapping J or L to trim a frame at a time
   - Pressing J or L to trim with real time playback
   - Pressing J or L repeatedly to trim in fast-reverse or fast-forward, at a variety of speeds

As you dynamically trim, all audio clips in all audio tracks will play back as the playhead scrolls across them, so you can hear your entire mix as you’re trimming.

6. After you’ve made a trim, pressing the Spacebar initiates Play Around Current Selection so you can see how that trim plays.

   In Dynamic mode, the Spacebar only executes a Play Around Current Selection operation, rather than play forward as it usually does. What is played by Play Around Current Selection depends on what is selected; a selected edit plays around just that edit, a selected clip plays around the whole clip, multiple clips or edits play around the total selection, including the current Pre-Roll and Post-Roll settings in the Editing panel of the User Preferences.
When you're finished, you can use the Up and Down Arrow keys to move both the selection and playhead to another edit point or clip you'd like to trim, or you can press W again to toggle Dynamic mode off.

You always want to be sure to turn Dynamic mode off when you're done, because otherwise using JKL will continue trimming selections whenever one or more edits or clips are selected, instead of playing the Timeline.

**NOTE:** While Dynamic mode is enabled, you can use JKL for playback if no clips or edit points are selected (press Command-Shift-A to deselect all). However, if anything in the Timeline is selected, then JKL will trim the selection as described above.

---

### Trim Operations that are Targeted Using the Playhead

The following series of Trim editing commands let you trim clips and edits in different ways using the position of the playhead to guide the result.

#### Trim Start and Trim End

The Trim > Trim Start (Shift-\[) and Trim End (Shift-\]) commands let you move the In or Out point of all clips that intersect the playhead as either a ripple operation (in Trim mode) or a resize operation (in Selection mode). You do not need to make a selection to use Trim Start and Trim End, making these commands fast to use in the right situation. A classic use of Trim End is when you have several superimposed clips of different lengths that you want to either start or end at the same time.

- Trim Start resizes or ripples (depending on what mode you're in) all clips that intersect the playhead, so that each clip's In point is moved to the current playhead position.

---

Before and after a Trim Start operation, all clips that intersect the playhead are trimmed.
Trim End resizes or ripples intersecting clips so that each intersecting clip's Out point is moved to the current playhead position.

Before and after a Trim End operation, all clips that intersect the playhead are trimmed; clips that don't intersect the playhead are not affected.

Clips that don't intersect the playhead are not affected. Furthermore, you can exclude clips on specific tracks from this operation by disabling the Auto Select controls on those tracks.

Resizing, Ripple, and Roll Start and End Commands

Another set of commands in the Trim menu lets you combine the Trim Start and Trim End functions with the act of choosing either Selection or Trim mode, and the ability to resize, ripple, or roll, all with single commands.

- Resize Start to Playhead
- Resize End to Playhead
- Ripple Start to Playhead (Command-Shift-\[)
- Ripple End to Playhead (Command-Shift-\])
- Roll Start to Playhead
- Roll End to Playhead

Just as with Trim Start and Trim End, these commands use the Timeline Auto Select controls to determine, of all clips intersecting the playhead, which clips on which tracks to trim. Many of these commands don't have keyboard shortcuts by default, but if you prefer this way of working, you can assign them to keyboard shortcuts of your choosing using the Keyboard Mapping Customization tool (Option - Command - K).
Slip and Slide Playhead to In and Out Commands

Yet another set of commands in the Trim menu lets you slip a clip from the frame at the current position of the Playhead to the In or Out point of that clip.

- Slip Playhead to In
- Slip Playhead to Out

**TIP:** The Slip Playhead to In command functions identically to using the extend edit while the playhead intersects a selected clip.

Just as with Trim Start and Trim End, these commands use the Timeline Auto Select controls to determine, of all clips intersecting the playhead, which clips on which tracks to trim. These commands don’t have keyboard shortcuts by default, but if you prefer this way of working, you can assign them to keyboard shortcuts of your choosing using the Keyboard Mapping Customization tool (Option - Command - K).

**Extend Edits**

The Extend Edit command (choose Trim > Extend Edit, or press E) lets you resize or ripple one or more selected edit points or clips. Unlike Trim Start and Trim End, it doesn’t matter if the playhead intersects clips when doing an extend edit.

**Extend Editing Edit Points**

Make one selection per track of any combination of In or Out points, and press the E key to move those edit points to the current position of the playhead.

Before and after a multi-track extend edit performed in Selection mode. Before, the red selections indicate that you’ve selected the first frame of media for those clips. After, the selections turn green to indicate that there’s additional frames at the head of the edit for trimming.
In Trim mode, selected edit points will ripple instead of resizing affected clips. However, to simplify multi-track extend edit operations when using the Trim tool, the lowest numbered video track with auto-select enabled defines the amount by which the extend edit will ripple the rest of the Timeline; all selected edit points on other tracks are simply resized to the position of the playhead.

Before and after a multi-track extend edit performed in Trim mode; you can see that the lowest numbered track with a selection defines how far the Timeline will be rippled.
Using Extend Edits to Slide Clips

You can also use the Extend Edit command to slide the contents of a single selected clip using either the Selection or Ripple tools. Simply select a clip, position the playhead over the frame of that clip you want to slide to the In point of that clip’s position in the Timeline, and press E to perform the slide. You can even do this during playback if you want to watch the clip play and press E to slip that frame back when the moment feels right.
Chapter 45

Working with Audio in the Edit Page

DaVinci Resolve has a solid set of features for editing, mixing, and mastering audio in your programs right in the Edit page. Whether you’re adjusting synced audio for dailies, finessing the levels of an edited project you’re assembling, mixing a program for output, or importing and laying in audio mix files from the sound designer to output for mastering, DaVinci Resolve has Level, Pan, and Channel Assignment controls to control your audio output for both monitoring and delivery, automated fader recording at both the track and clip level for mixing, and VST and Audio Unit audio filter support for mastering audio tracks and channels using industry-standard noise reduction, compression, EQ, and other filters. And, if all that’s not enough for you, you can export to Pro Tools in the Delivery page to hand off your program and its audio in a state ready for further work.

When you’ve finished doing the editorial audio work in your program, and you want to really drill into your program’s audio for detailed audio editing and mixing, you can use the audio-specific tools of the Fairlight page. For more information, see Chapter 167, “Using the Fairlight Page.”

Contents

Audio in the Edit vs. Fairlight Pages 772
Compatible Audio Formats 772
Assigning Audio Channels in the Media Pool 772
How to Assign Audio Channels 772
Support for Mixed Audio Track Formats from Source Clips 775
Editing Audio Into the Timeline 776
Editing Audio Using the Source Viewer 776
Simultaneous Audio Waveform Display in the Source Viewer 776
Using Multi-Channel Timeline Tracks 777
Audio in the Edit vs. Fairlight Pages

While the Fairlight page provides dedicated audio editing and mixing capabilities that are suitable for sweetening the audio of your program once it’s been edited, the Edit page has extensive audio capabilities of its own. This enables editors to edit and refine audio clips, set levels, and do simple mixes as they assemble the program in the first place. However, once things have been edited together, you’re meant to go freely back and forth between the Edit and Fairlight page as you refine your work, using whichever environment is most suitable for the task at hand.

Compatible Audio Formats

DaVinci Resolve is compatible with WAVE, Broadcast WAVE, AIFF, MP3, AAC (M4A), CAF, iOS Voice Memo (macOS only), both MTS and QuickTime containers that use the AC3 audio format, and Enhanced AC-3 (macOS and Windows only). DaVinci Resolve is compatible with audio at sample rates including 32, 44.1, 48, 88.2, 96, and 192 kHz.

Assigning Audio Channels in the Media Pool

When you first import audio into the Media Pool, it’s a good idea to make sure that whatever channels those files contain are assigned correctly before you start editing clips into the Timeline. In other words, you want to make sure that stereo files are set to be stereo clips, that 5.1 and 7.1 files are set to be surround clips, and that multi-channel files are set to expose however many tracks you want to edit separately in your program. Clip channel assignments are made in the Audio panel of the Clip Attributes window.

This is particularly important when clips have more than two channels of audio. For example, production sound recordists might record three, six, or even more audio channels, corresponding to multiple microphones used on set to simultaneously record different actors plus a mixdown track. In this case, you need to define how many of these channels you want to play (or mute), and how many audio items you want to appear in the Edit and Fairlight page Timelines.

Mono, stereo, 5.1, and 7.1 clips are handled automatically, but multi-channel clips needing custom assignments in the Media Pool should be remapped as necessary using Clip Attributes, so that DaVinci Resolve can more easily place incoming audio clips into the correct track of the Timeline. You can alter the clip attributes for clips one at a time, or for multiple selected clips at once. For more information on these settings, see Chapter 21, “Modifying Clips and Clip Attributes.”

How to Assign Audio Channels

Each clip with audio has the following options in the Audio panel of the Clip Attributes window:

The controls available for adding tracks with which to remap channels
A set of controls at the top of the Track/Channel list lets you add additional tracks to a clip. Adding additional tracks to a clip let you remap that clip’s available channels to appear as additional items in the timeline when you edit it, one item per track with an unmuted channel.

How you handle audio in your timeline is up to you. In the case of production audio consisting of five channels, four for different microphones plus one mixdown channel, you might use Clip Attributes to map all channels to a single track.

The Audio panel of the Clip Attributes window for a single-track clip with four channels

With this mapping, this audio clip exposes only one item on one track in the Edit page Timeline, or five lanes within a single track in the Fairlight page Timeline. Either way, this mapping exposes a single editable unit.

A single audio channel exposed in the Timeline

Optionally, you could choose to mute the four individual microphone channels and only monitor the top mixdown channel. This can be accomplished by setting channels 2-5 to mute. Muted channels are always retained, just not heard, and you can turn them back on whenever you like using by right-clicking a clip in the Timeline and choosing Clip Attributes to get back to these controls for the specific timeline clip you’ve edited.
The Audio panel of the Clip Attributes window for a clip with four channels muted

**NOTE:** If you export audio clips with muted tracks to Pro Tools in the Deliver page, the muted channels are exported as well.

Alternately, you might elect to set these clips up with five separate audio tracks with a single audio channel each, in order to expose each channel separately in the Timeline for independent editing. First, set the top track to be Mono using Embedded Channel 1. Then, using the Add channel controls at the top of the channels list, you can set Tracks to 4, format to Mono, and click Add to create four additional tracks in addition to the one track that clip had originally. Remapping channels 2-5 to these new tracks will result in the track mapping seen in the following screenshot.
Editing such a clip into the Timeline results in five linked audio items appearing on five separate audio tracks, each of which can be edited separately in the Timeline.

Each channel exposed as a separately editable clip in the Timeline

Support for Mixed Audio Track Formats from Source Clips

DaVinci Resolve also supports media with multiple audio tracks that have differently formatted channels embedded within them. For example, a clip with one stereo track, one 5.1 surround track, and six mono tracks can all be appropriately set up in the Audio panel of Clip Attributes after that clip has been imported.

The Audio panel of Clip Attributes now has controls over what format (Mono, Stereo, 5.1, 7.1, Adaptive) the channels embedded within a particular clip should be configured as. This means that you can set up clips with multiple tracks, each one using potentially different formats of audio employing different combinations of clips, which is handy for mastering.

Clip Attributes now lets you assign channels among different tracks with different channel assignments.
Editing Audio Into the Timeline

A separate set of audio tracks in the Edit page Timeline contain all of the audio that you edit into the Timeline, as well as any stand-alone audio files that might have been imported along with an AAF or XML file.

Editing Audio Using the Source Viewer

Opening an audio-only clip into the Source Viewer, or opening a clip with both video and audio and setting the Viewer to Audio Waveform results in a split view, with the complete waveform of the entire source clip shown in the top half, and a zoomed-in view of the waveform in the bottom half that can be set to zoom from 1x to 50x from the Zoom menu at the upper left-hand corner of the Source Viewer. This view makes it easy to drag the box at the top to find the section of audio you need relative to the entire clip, and yet still place In and Out points with great precision using the scrubber bar below.

This view shows every channel within each track of the current clip.

An audio clip opened into the Source Viewer

You can add markers and set In and Out points for audio clips just as you would for any other clip, in preparation for editing.

Simultaneous Audio Waveform Display in the Source Viewer

It's also possible to edit using audio waveforms even when the Source Viewer is set to Source. Two options in the Option Menu let you see a superimposed audio waveform running along the bottom of the Viewer, over the video of the currently selected clip.

- **Show Current Frame Audio Waveform:** Shows a zoomed-in section of audio that scrolls as you play the clip. Useful for seeing dialog and music cues as you play through a clip.
- **Show Full Clip Audio Waveform:** Shows the audio waveform for the entire source media of that clip. The section of audio from the In to Out points you've set in the Source Viewer are highlighted. Useful for using the audio waveform to navigate throughout that clip using the waveform as a reference.
Using Multi-Channel Timeline Tracks

Multi-channel audio tracks in the Edit page Timeline are extremely convenient when you’re dealing with clips that are stereo, 5.1, 7.1, or have an arbitrary number of channels that were recorded in the field, as you can fit all of these channels as a single clip into a single track, that will be correctly mapped to your project’s outputs, and that can be edited conveniently as a single item in the Timeline.

However, when you open the Fairlight page you’ll see that although the overall number of audio tracks is identical to the Edit page, the Fairlight page shows the channels that are otherwise hidden on the Edit page as lanes within each track, which expose each channel as a visible audio item in the Timeline. In this way, editors can work with multi-channel audio without worrying about visual clutter, while audio editors and mixers can see every channel on every track to help them get their work done.

Getting back to audio tracks on the Edit page, there are different types of audio tracks just like there are different types of audio clips: Mono, Stereo, 5.1, 7.1, and Adaptive. While you can edit any kind of audio clip into any kind of audio track, all clip audio channels that exceed the number of channels possessed by a particular type of timeline track will be muted. For example, you’re allowed to edit a six-channel Adaptive audio clip into a Mono audio track, but only the first channel will play because the Mono track only outputs one channel.

Because of this, it’s a good idea to organize your timeline such that all clips appear on tracks that can accommodate the number of channels they have.

**TIP:** Editing an audio clip into the undefined gray area below existing audio tracks in the Timeline will result in the automatic creation of new audio tracks that are equal in number to the number of tracks the clip you’re dragging has, and each new track will have audio mappings that match the incoming audio items.
Defining Timeline Audio Track Channels at Creation

When you first create a new audio track, you have to choose what kind of audio track it will be. Right-clicking in the bottom audio portion of the Timeline track header reveals a contextual sub-menu that lets you create one of three different kinds of audio tracks.

- **Mono**: Holds a single channel.
- **Stereo**: Holds stereo left and right channels. Stereo tracks can be panned.
- **5.1**: Holds the six channels corresponding to a 5.1 surround mix. For broadcast, SMPTE specifies Left, Right, Center, LFE, Left Surround, Right Surround. For cinema distribution these tracks are ordered Left, Center, Right, Surround Left, Surround Right, and LFE.
- **7.1**: Holds the eight channels corresponding to a 7.1 surround mix. For broadcast, SMPTE specifies Left, Right, Center, LFE, Left Surround, Right Surround, Back Surround Left, and Back Surround Right. For cinema distribution these tracks are ordered Left, Center, Right, Left Surround, Right Surround, LFE, Back Left Surround, and Back Right Surround.

- **Adaptive**: Capable of holding up to 24 audio channels. An adaptive audio track can hold clips with different combinations of channels, up to the maximum number of channels allowed within that track. The number of channels allowable on a particular Adaptive track is user-definable (1–24) at the time that track is created. If you edit a clip with more channels into an Adaptive track that was created to hold fewer channels, the extra channels are muted.

Changing How Many Channels an Audio Track Has

If you had set up your timeline with one kind of audio track, but you discover you actually need a different kind, you can change any audio track’s type at any time. Just right-click anywhere in that audio track’s timeline header, and choose an option from the Change Track Type To submenu of the contextual menu.
Creating Timelines With Audio Mixer Presets

For advanced audio workflows and ease of use with Fairlight, you can now create a timeline with pre-assigned audio tracks using a previously created Fairlight Configuration preset. To use this function, create a new timeline, and check the "Use Fairlight Configuration Preset" box. A drop-down menu then appears, allowing you to select the specific preset for the Timeline.

You can create Fairlight Configuration presets using the Fairlight Presets Library, available from the Fairlight menu. For more information, see Chapter 168, "Setting up Tracks, Buses, and Patching" in the DaVinci Resolve Manual.

Editing Audio Clips Into the Timeline

When you edit a video clip with accompanying audio, or an audio-only clip, into the Edit page Timeline, what you see depends on how the audio's internal tracks and channels were defined in the Media Pool, using Clip Attributes. If you've defined a clip to expose multiple tracks of audio, each exposing a different channel, then you exchange the convenience of managing multiple channels of audio as a single item for the freedom to individually edit each channel of audio separately, as individual clips in the Timeline.

For example, if you've been given a multi-channel recording that consists of two boom microphones, two separate lavaliere microphones, and a mixdown track that were recorded simultaneously, you can use the Audio panel of the Clip Attributes window to set that clip's audio up as 5-channel Adaptive audio with 5 tracks containing one channel each. Editing this into the Timeline, you end up with five separate audio items appearing in five tracks.

This way, when you edit that clip into the Timeline, each audio channel appears as its own clip in its own audio track of the Timeline, which can be separately edited so you can edit the scene to isolate the best dialog from each microphone.
Changing Audio Clip Attributes After Editing

It’s best to make decisions about which audio tracks and channels are assigned prior to beginning editing. This is because once you’ve edited a clip into a timeline, you can’t use the Clip Attributes window to edit how many audio tracks and audio channels are exposed in the Timeline.

However, you can use Clip Attributes to change which channels are assigned and/or muted within the available tracks and channels you’ve edited into the Timeline. For example, if you’re editing clips that have five channels of source audio (channels 1 and 2 are a stereo mix and channels 3 through 5 are three different microphones), you may have set your synced source clips to have one audio track and five audio channels, with channels 3–5 muted. Later you have a few clips that would sound much better if you only used channel 4, which is the isolated lavaliere microphone for that actor, so you can select those clips and use the Audio panel of Clip Attributes to mute all channels but channel 4.

If, for whatever reason, you need to expose more audio tracks in the Timeline than you originally set an audio clip to use, you can do the following.

To re-edit an audio clip to expose more audio tracks than were originally available:

1. Right-click the clip you want to change the audio track mapping of in the Timeline, and choose Find in Media Pool from the contextual menu.
2. Right-click that clip in the Media Pool and choose Clip Attributes from the contextual menu.
3. Open the Audio panel of the Clip Attributes dialog, and choose how many audio tracks and audio channels you want to set that clip up with. Click OK.
4. Once that’s done, edit the changed audio clip from the Media Pool to the Timeline to replace the original clip using whichever method makes sense.

Displaying Waveforms in the Timeline

The Timeline View options palette lets you turn Audio Waveform display on and off via a button at the top. The Audio View options let you define how you wish your waveforms to be presented on the Timeline.
– **Audio View Options:** Three buttons govern the look of audio waveforms in the Timeline, when visible.

  – **Non-Rectified Waveform:** Lets you toggle between the waveform being drawn from the bottom of the audio track up, or centered and mirrored about itself.

  – **Full Waveform:** Hides the divider bar that keeps the waveform separate from the file name area of each audio clip, so the waveform occupies the full space of each audio bar in the Timeline.

  – **Waveform Border:** Draws a dark border around the edges of each waveform to make them easier to see.

– **Video track height slider:** Lets you resize the size of all video tracks at once, independently of the audio tracks.

– **Audio track height slider:** Lets you resize the size of all audio tracks at once, independently of the video tracks.

While a single averaged audio waveform representing all the channels in that clip is shown by default, you can switch any clip to seeing each individual waveform in a vertical stack by right-clicking any audio clip and choosing Display Individual Audio Channels.

Whenever you cut an audio clip, you cut all audio channels with it. Audio channels that are embedded within a single track cannot be individually edited.
Editing Audio In the Timeline
Using In and Out Points

Audio clips can be edited using all of the commands and tools available for video clips. However, it’s good to know that one of the most common techniques of editing audio in other environments is available in DaVinci Resolve, and that is the ability to identify a range of audio to cut, copy, or delete using Timeline In and Out points, so that you can easily eliminate, move, or duplicate partial sections of audio without having to use the Razor Edit or Split Clip commands.

To delete a section of audio using In and Out points:
1. Set In and Out points in the Timeline to identify the range of audio you want to eliminate. If necessary, turn off the Auto Select controls of tracks to omit overlapping audio clips you don’t want to delete from this operation.

2. Press the Backspace key to delete the section of audio and leave a gap, or press the Forward Delete key to delete the section of audio and ripple the Timeline to close the gap.

To copy a section of audio using In and Out points:
1. Set In and Out points in the Timeline to identify the range of audio you want to copy. If necessary, turn off the Auto Select controls of tracks with overlapping audio you don’t want to copy; you can Option-click the Auto Select control of the audio track you’re copying from to solo it, and you can Shift-click any video track’s Auto Select control to turn them all off. In this example, we’re copying some background ambience to continue building an ambience track.
Setting In and Out points to identify a range of audio to copy

2 Press Command-C to copy that section of audio.

3 Press Option-X to clear the Timeline In and Out points, and move the playhead to where you want to paste the copied section of audio.

4 Press Command-V to paste the copied audio. If you’re looping a section of audio, you can paste many times to loop what you’ve copied.

Resizing Audio Clips in Subframe Increments

DaVinci Resolve lets you optionally make subframe audio adjustments to the In and Out points of audio clips in the Timeline.

Enabling and Disabling Subframe Editing

The “Align audio edits to frame boundaries” preference in the Editing panel of the DaVinci Resolve User Preferences lets you choose whether audio clip In and Out points align to whole frame boundaries, just like video clips. When this option is turned on, you cannot make subframe audio edits. When turned off (the default), you can.

Subframe Editing of In and Out Points

While you cannot move the playhead in subframe increments, you can resize audio clips in subframe increments by dragging an audio clip’s In or Out point in the Timeline, or by dragging an audio edit to perform a roll. This can be useful for trimming minute bits of audio such as pops, clicks, or vocalizations.
Resizing the Out point of an audio item in subframe increments, seen within a one-frame playhead shadow

Know that if you have Linked Selection turned on and you’re trying to resize a selected Video+Audio pair of items, the whole-frame resizing required for video prevents you from being able to resize the audio separately. This is easily solved by Option-Clicking to select the linked audio item by itself, at which point you can subframe resize it freely.

Also, if snapping is enabled, it may be impossible to make a subframe adjustment if you’re too close to another edit point, a marker, or the playhead. In this case, pressing the N key to turn snapping off will solve the problem.

**Eliminating Subframe Audio Edits**

If you’ve done a variety of subframe edits and you discover you need to eliminate these subframe adjustments, you can choose Timeline > Trim Audio Edits to Frame Boundaries. This moves each subframe edited In or Out point in the timeline to the nearest frame boundary.

**Audio Settings in the Inspector**

Each clip has some simple audio-related parameters in the Audio panel of the Inspector.

- **Volume**: Each clip has a single volume control that corresponds to the volume overlay over each audio clip.

- **Pan**: (Only exposed for clips) A simple Pan slider that controls stereo panning.

- **Pitch**: Lets you alter the pitch of a clip without changing the speed. Two sliders let you adjust clip pitch in semi tones (large adjustments, a twelfth of an octave) and cents (fine adjustments, 100th of an octave).

- **Equalizer**: Each clip also has a four-band EQ, complete with low-pass, high-pass, and parametric settings for fine tuning and problem-solving audio issues at the clip level.

Additionally, when you apply other audio plug-ins from the Audio FX panel of the Effects Library, additional parameters and controls are exposed (covered towards the end of this chapter).

**Setting Volume**

Each audio clip, or audio item in the case of audio clips with linked audio on multiple tracks, has its own Volume level. This means that audio clips with multiple channels share a common Volume setting. There are several ways you can adjust these levels simply.
Adjusting Audio in the Inspector

Each clip has individual Volume parameters that are accessible in the Audio panel of the Inspector when one or more audio clips are selected.

Selecting an audio clip in the Timeline and adjusting its volume only alters that clip, which lets you set basic levels for individual clips in your program. The Volume control affects every channel within that clip simultaneously.

If you select multiple clips in the Timeline, then adjusting the Volume sliders or virtual sliders for all of them simultaneously will make a relative adjustment to all of the clips, preserving their offsets from one another. If you want to set all clips to the same level, then making a numeric adjustment will set all selected clips to the same absolute level.

Adjusting Audio in the Timeline

Each clip (or item) of audio in the Timeline has a Volume overlay that lets you set that clip’s level by simply dragging it up or down with the pointer. This overlay corresponds to the Volume parameter in the Inspector.

You can also click the Curve Editor button at the bottom right-hand corner of the audio clip, which opens the Audio Curve Editor. At the time of this writing, the only parameters you can edit in this Curve Editor is volume and pan.
Adjusting Volume Using Keyboard Shortcuts

You can also adjust the volume of selected clips using keyboard shortcuts, even while the Timeline is playing. There are several ways you can set this up.

- **To adjust just one clip**: Select that clip, and use one of the commands for changing volume.
- **To adjust any clip at the position of the playhead**: Turn on Timeline > Selection Follows Playhead so that whichever clip intersects the playhead becomes selected, and use one of the commands for changing volume. If multiple clips are intersecting the playhead, the selected clip will be the one on the highest track.
- **To adjust multiple clips all together**: Select all of the clips you want to adjust, all at once, and use one of the commands for changing volume. If the clips you select have differing Volume levels, these differences will be maintained as you make your adjustments.

The commands for changing volume are as follows:

- **To change volume in increments of 1dB**: do one of the following:
  - Clip > Audio > Increase Audio Level 1dB (Option-Command-Equals)
  - Clip > Audio > Decrease Audio Level 1dB (Option-Command-Minus)

- **To change volume in increments of 3dB**: do one of the following:
  - Clip > Audio > Increase Audio Level 3dB (Option-Shift-Equals)
  - Clip > Audio > Decrease Audio Level 3dB (Option-Shift-Minus)

Normalize Audio Volume Command

The Normalize Audio Levels command automatically adjusts the level of clips to a specific target level, and you can choose the method used to analyze each audio clip’s levels to determine how to normalize each clip’s volume. Options include a variety of loudness normalization algorithms specific to various international standards, which are useful for balancing the perceived overall loudness of several clips to one another, regardless of transient levels throughout each clip. You can also do Peak normalization, with options for both Sample Peak and True Peak.

The various loudness options are designed to analyze an audio signal based on its perceived loudness to the listener, which results in a more accurate automatic balancing of different clips’ audio levels to one another, regardless of transient peaks occurring throughout different clips.

The target peak meter now uses the BS.1774 standard for measuring maximum “true peak,” which means that this meter is capable of measuring “inter-sample peaks,” rather than only the peaks at each sample of a waveform. However, you still have the option to measure Sample Peak, which is the previous method of measuring the actual peak of the samples in a media file.

The change made by the Normalize Audio Volume command is only a volume adjustment; no dynamics are applied, so the result of using this command is that the loudest parts of each selected clip are going to match one another at the target level. This command is also available in the Fairlight page.
To normalize one or more selected audio clips:

1. Right-click one of the selected clips and choose Normalize Audio Levels. The Normalize Audio Level dialog appears.

![Normalize Audio Level dialog](image)

2. Choose the Normalization Mode you want to use. You can choose among a variety of standardized loudness measurement algorithms, or Sample Peak, or True Peak.

3. Choose the reference level that you want to set the peak volume of the selected clips to match.

4. Choose how you want to set the level of multiple selected clips:
   - When Set Level is set to Relative, all selected clips are treated as if they’re one clip, so that the highest peak level of all selected clips is used to define the adjustment, and the volume of all selected clips is adjusted by the same amount. This is good if you have a series of clips, such as a dialog recording, where the levels are consistent with one another, and you want to normalize all of them together.
   - When Set Level is set to Independent, the peak level of each clip is used to define the adjustment to that clip, so that the volume of every selected clip is adjusted by an amount specific to that clip. The end result may be a set of very different volume adjustments intended to make the peak levels of each audio clip match one another. This is good if, for example, you’re trying to balance a series of different sound effects with one another that have very different starting levels.

For more information about loudness normalization, see Chapter 178, "Audio Meters and Audio Monitoring."

**Pan**

Each audio clip in the Timeline has a simple stereo Pan control that lets you pan that clip. While most professional mixes will restrict panning to the more robust panner found in the Fairlight page Mixer, this simple clip-based Pan control is useful for editors of visuals working in the Edit page to quickly create simple panning effects to aid in a craft edit. Dragging the slider lets you pan audio left to right. This control is centered at 0 by default.

![Clip Pan Control](image)
Pitch

Selecting a clip and opening the Inspector reveals a new set of Clip Pitch controls that let you alter the pitch of a clip without changing the speed. Two sliders let you adjust clip pitch in semi tones (large adjustments, a twelfth of an octave) and cents (fine adjustments, 100ths of an octave).

Equalizer

Each audio clip in the Timeline has a four-band equalizer that has both graphical and numeric controls for boosting or attenuating different ranges of frequencies within that clip, before it even gets to the EQ built into the mixer. Each band has controls for the filter type (Bell, Lo-Shelf, Hi-Shelf, Notch), Frequency, Gain, and Q-factor (sharpness of the band), with the available controls for each band of EQ changing depending on the filter type.

When a channel strip’s EQ is enabled, the EQ button displays the equalization curve that’s being applied. This indicator cannot be adjusted; you must open the EQ window to make modifications.

Master EQ Controls

The Equalizer window has the following overall controls:

- **Enable button:** Turns the overall EQ effect off and on, without resetting the controls.
- **Reset button:** Resets all controls of the EQ window to their defaults.
Graphical EQ controls

A graph at the top shows a curve with handles that correspond to each of the enabled EQ bands listed below. You can drag any numbered handle to boost or attenuate the range of frequencies governed by that band, using whatever type of equalization that band has been set to.

Dragging the numbered handles on this graph in turn modifies the parameters of the corresponding band, and changing each band’s parameters will also alter the EQ graph, which serves the additional purpose of providing a graphical representation of the equalization being applied to that track.

Bands 1 and 4

The outer two sets of band controls let you make high-pass and low-pass adjustments, if necessary.

- **Band enable button**: Turns each band of EQ on and off.
- **Band filter type**: Bands 1 and 4 can be switched among six specific filtering options for processing the lowest or highest frequencies in the signal. These include (from top to bottom): Lo-Pass, Lo-Shelf, Bell, Notch, Hi-Shelf, and Hi-Pass.
- **Freq**: Adjusts the center frequency of the EQ adjustment.

Bands 2 and 3

The middle two sets of band controls let you make a wide variety of equalization adjustments.

- **Band enable button**: Turns each band of EQ on and off.
- **Band filter type**: Bands 2–3 can be switched among four different filtering options (from top to bottom) Lo-Shelf, Bell, Notch, and Hi-Shelf.
- **Frequency**: Adjusts the center frequency of the EQ adjustment.
- **Gain**: Adjusts the amount by which the affected frequencies are affected. Negative values attenuate those frequencies, while positive values boost those frequencies.
- **Q Factor**: Adjusts the width of affected frequencies. Lower values include a wider range of frequencies; higher values include a narrower range of frequencies.

Keyframing Audio

There are two ways you can keyframe audio in the Edit page. You can use each audio clip’s volume curve in the Timeline, or you can use the keyframe controls in the Inspector to animate the Volume parameter of individual clips as you would any other clip attribute, fading the level up or down, panning from left to right, or dynamically changing any one of a host of filter controls, in subframe increments, if necessary.
For more information on keyframing in the Inspector, see Chapter 54, “Keyframing Effects in the Edit Page.” Any keyframes you create using the Keyframe controls of the Inspector automatically appear on the volume curve of that audio clip in the Timeline.

**Overlay Controls for Volume**

Each audio clip in the Timeline appears with a Volume overlay control on top of it, that by default starts out completely flat. Similar to such controls found in other applications, the level curve lets you alter each clip’s levels, either overall, or dynamically using keyframes.

Additionally, you can click any clip’s Audio Curve Editor button, at the bottom right-hand corner of each audio clip, to open an audio-specific Curve Editor in which you can also keyframe volume.

**How to Add and Adjust Volume Keyframes**

Mixing audio by adding and adjusting individual keyframes can be a fast and effective way of balancing clip levels with one another, fixing level problems within a particular clip, or even creating simple mixes (although the mixing capabilities of the Fairlight page are considerably more robust).

When manually editing any audio parameter curve, you can use the following procedures.

**Methods of adding or selecting audio keyframes using the pointer:**

- **To add keyframes to the Volume curve:** Hold the Option key down and click the curve to place a keyframe at that frame. You must add at least two keyframes to create an automated change in Volume.

- **To select one or more keyframes:** Click any keyframe to select it.

- **To select multiple discontiguous keyframes:** Command-click all keyframes you want to select, whether they’re next to one another or not.

- **To select multiple contiguous keyframes:** Click the first keyframe you want to select, and then shift-click the last keyframe you want to select, and all keyframes between will also be selected.

**Methods of adjusting keyframes in the Volume overlay (or curve) using the pointer:**

- **To adjust any curve segment:** Position the pointer over the overall segment for clips with no keyframes, or position it between any two keyframes, directly on top of the curve segment you want to raise or lower. When the Move cursor is displayed, click and drag up to raise the volume, or down to reduce the volume.
– **To adjust a keyframe in any direction:** Move the pointer over a keyframe so that the four-way cursor appears, and then click and drag up or down to change the volume, or side to side to change its timing. The timing of audio keyframes can be adjusted in subframe increments, for precision mixing.

– **To adjust a keyframe in only one direction:** Move the pointer over a keyframe so that the four-way cursor appears, press Shift, and click and drag in the intended direction of adjustment, either vertically to change the volume of the clip at that frame, or horizontally to move the keyframe to a different point in time. Once you start dragging a keyframe into a particular direction, keyframe movement is constrained in that direction until you release that keyframe. The timing of audio keyframes can be adjusted in subframe increments, for precision mixing.

– **To change one or more Linear keyframe to Ease In or Ease Out:** Eased keyframes create animated changes that begin slowly and accelerate to full speed, or slow down gradually to decelerate to a stop. This only works when you have two or more keyframes creating an animated effect. Select one or more keyframes, then right-click one of the selected keyframes and choose Ease In, Ease Out, or Ease In and Out, depending on which keyframe you’re editing and the effect you want to create.

– **To change one or more eased keyframes to Linear:** Select one or more keyframes, then right-click one of the selected keyframes and choose Linear.

**Methods of Cutting, Copying, Pasting, and Deleting keyframes:**

– **To cut or copy, and paste one or more keyframes:** Make a selection of keyframes, and use the Cut (Command-X) or Copy (Command-C) key shortcuts. Then, move the playhead to where you want the first of the copied keyframes to start, and press Paste (Command-V).

– **To delete one or more control points from a curve:** Select the keyframe(s) you want to delete and press Backspace.

### Audio Fade Handles

When you position the pointer directly over an audio clip, a pair of Audio Fade handles appear at the In and Out points. Dragging each of these handles towards the center of the clip lets you fade in the clip volume at the beginning of the clip, and fade out the clip volume at the end of the clip.

![Audio Fade handles at either end of an audio clip](image)

**NOTE:** When you import a Final Cut Pro X project, the fade handles for each clip automatically import as well.

Audio Fade Handles can also be adjusted in subframe increments, if necessary, to create a precise transition.
Once you’ve created a fade effect, you can adjust the curve of the fade by dragging the handle that appears right on top of the fader curve. Dragging the handle up and down affects the angle of the curve, and dragging the handle left and right affects the shape of the curve. In this way, you can create all manner of fade effects.

Fade effects can be created and edited on both the Edit and Fairlight pages.

## Audio Crossfades

When you select an edit point with both video and audio components, and Linked Selection is enabled so that both the video and audio edit points are selected, then when you apply a video transition to an edit, a crossfade is added to the audio.

You can add Cross Fade transitions to any edit point between two audio clips that have enough handles similarly to how you add video transitions, by dragging and dropping from the Effects Library, by right-clicking an edit and choosing an option from the contextual menu, or by selecting an audio edit point and choosing Timeline > Add Audio Only Transition (Shift-T).

Cross Fade transitions are a quick and easy way to fade the volume of the outgoing clip down while simultaneously fading the volume of the incoming clip up, letting you create a smooth aural transition between two audio clips. If you need to do precision editing, the start and end points of a crossfade can be edited in sub-frame increments.

You can double-click a Cross Fade transition to open it into the Inspector, revealing the following parameters:

- **Duration**: The duration of the transition, shown in both seconds and frames.
- **Alignment**: A drop-down that lets you choose the transition’s position relative to the edit point it’s applied to. Your choices are “End on Edit,” “Center on Edit,” and “Begin on Edit.”
– **Transition style:** You can choose –3dB, 0dB, or +3dB to set both the Fade In and Fade Out levels to the same value. For more information on what these levels mean, see the following parameter.

– **Fade In/Fade Out levels:** There are three options that affect the incoming and outgoing halves of the Cross Fade effect independently. 0dB applies a linear fade (this is the default). +3dB applies a boosted curve; when applied to both Fade In and Fade Out, this can compensate for diminished levels in the middle of a Cross Fade. –3dB applies an attenuating curve, which deliberately lowers the level of the Cross Fade.

Crossfades can be created and edited on both the Edit and Fairlight pages.

---

**TIP:** If you need an asymmetrical crossfade, that’s accomplished by “checkerboarding” clips on two tracks with overlapping handles at the beginning and end, and using the Fader handles to create exactly the timing and curves necessary to create the effect you require.

---

### The Audio Mixer

The Audio Mixer on the Edit page is a simplified version of the Mixer on the Fairlight page, designed to provide a streamlined set of graphical controls you can use to set basic track levels (there is no track level fader automation on the Edit page), pan stereo audio at the track level, and mute and solo tracks as you work.

**To open the Audio Mixer, do the following:**

– Click the Mixer button on the Interface toolbar.

The Audio Mixer exposes a set of channel strips with controls that correspond to the tracks in the Timeline, and each channel strip displays a number of audio meters equal to the number of channels within that track. By default, a Main 1 channel strip appears all the way to the right that lets you adjust the overall level of the mix. However, if you add subs and mains on the Fairlight page, those will appear at the right of the mixer as well.
NOTE: You cannot record automation in the Edit page. Comprehensive mixing controls with full automation recording are found in the Fairlight page.

Audio Mixer Controls

Each track’s channel strip has the following controls:

- **Track Color**: Each track can be differently color-coded to help you keep organized. These colors also appear in the timeline track header and the Fairlight page.

- **Track Number**: The number of the timeline audio track corresponding to each channel strip appears here.

- **Pan control**: Lets you pan Mono track’s audio from left to right, or invert a Stereo track’s left and right audio channels, or do surround mixing.

- **Name**: The name of the audio track that channel strip corresponds to. If you’ve edited the audio track names in the Timeline, those names will appear here.

- **Solo**: Mutes all tracks other than ones that are soloed.

- **Mute**: Disables that audio track.

- **dB**: Shows you the volume, in decibels, that track is currently set to.

- **Fader**: Each track’s vertical fader can be dragged with your mouse or other pointing device to adjust the volume of that track and perform automation recording. Dragging up increases volume, dragging down decreases volume.

- **Audio meters**: Audio meters to the right of each fader display the audio volume of all channels on that track during playback. Each channel strip has individual meters corresponding to the number of channels that track has been set to accommodate.

Mute and Solo Tracks For Output

When you use the Mute or Solo controls of the Audio Mixer, track audio is disabled both during playback and delivery for output. Make sure you have re-enabled any tracks you need before heading to the Deliver page. You can only modify mute and solo tracks on the Edit, Cut, and Fairlight pages.

Displaying Audio Meters

If you just want to see your program’s levels, you can also switch to display the “Control Room” audio meters instead of the Mixer. How many audio meters appear depends on the current speaker configuration in the Video and Audio I/O panel of the System Preferences.

To show the Audio Meters:

- Click the Mixer button on the Interface toolbar to display the audio panel and then choose Meters from the option menu at the upper right-hand corner.

Audio Compound Clips

DaVinci Resolve supports audio compound clips, which are created just like any other compound clip, by selecting multiple audio clips, right-clicking one of them, and choosing New Compound Clip. Alternately, compound clips with video clips may now contain multiple audio items as well.
When compound clips containing audio are opened in the Edit or Fairlight pages by right-clicking an audio compound clip and choosing Open in Timeline, breadcrumb controls appear beneath the Timeline that let you exit the compound clip and get back to the master Timeline.

Audio Playback for Variable Speed Clips

Video/audio clips with variable speed effects applied to them can now play either pitch-corrected or un-pitch-corrected variable speed audio. An option in the Speed menu of the Retime controls lets you choose whether or not the audio is pitch-corrected.

Using Audio Filters

DaVinci Resolve includes Fairlight FX, a set of DaVinci Resolve-specific audio plug-ins that run natively on macOS, Windows, and Linux, providing high-quality audio effects with professional features to all DaVinci Resolve users on all platforms. Additionally, DaVinci Resolve supports the use of third-party VST audio plug-ins on Mac OS X and Windows. On Mac OS X, DaVinci Resolve supports Audio Unit (AU) audio plug-ins. Once you install these effects on your workstation, they appear in the Audio FX panel of the Effects Library.
Audio plug-ins let you apply effects to individual audio clips or entire tracks worth of audio, to add creative qualities such as echo or reverb, or to take care of mastering issues using noise reduction, compression, or EQ.

**Methods of applying audio filters to clips in the Edit page:**

- **To apply an audio filter to a clip:** Drag any filter from the Audio FX panel of the Effects Library onto the clip in the Timeline you want to apply it to.

- **To apply an audio filter to multiple clips:** Select all of the clips you want to apply an audio filter to, then drag any filter from the Audio FX panel of the Effects Library onto any of the selected clips.

**To edit a clip’s audio filters:**

- Select that clip and open the Inspector. All audio filters applied to that clip appear under the Effects panel, in the Audio tab, with that filter’s controls appearing directly in the Inspector.

Many VST and Audio Unit audio filters have a custom user interface that makes it much easier to manipulate that filter’s controls. These can be opened from within DaVinci Resolve.

![The custom audio filter interface for iZotope RX4](image)

**To expose a filter’s custom controls:**

- Click the Custom Control button (the button to the right of the trash can). The custom controls appear in a floating window. When you’re finished adjusting the custom controls, close the window.

![The button for opening a filter’s custom control](image)

**Methods of working with audio filters in the Inspector:**

- **To disable or re-enable a filter:** Click the toggle button at the far left of each filter’s title bar.

- **To remove a filter:** Click the Trash Can button.

Once applied to a clip or track, audio filters can also be keyframed or automated just like volume and pan settings, to create dynamic audio effects that change over time.
Installing Audio Filters

VST effects aren’t installed in a standard location, so it may sometimes be necessary to add a newly installed directory of VST plug-ins that you’ve just installed on your system. To help you deal with this, the Audio Plugins panel of the Preferences window has a list that lets you manually add and remove VST plug-in directories, if necessary.

Once you’ve added one or more VST directories to the list, a second list underneath shows all audio plug-ins that are available within these directories. Each plug-in on the list has a checkbox that shows whether or not it’s currently enabled. Any VST plug-ins that cause DaVinci Resolve to crash while loading them during startup will be automatically disabled.

You can use this list to see which plug-ins have been disabled, for troubleshooting purposes, and to reenable such “blacklisted” plug-ins, by turning their checkboxes back on.

The Fairlight Page

The audio controls of the Edit page are geared more towards simple mixing to have sensible levels as you work putting a program together. For comprehensive audio sweetening, mixing, automation, and mastering controls, the Fairlight page is only one click away.

For more information, see Part 12, “Fairlight.”

Pro Tools Export

It bears mentioning that, if the audio editing, mixing, and effects capabilities of DaVinci Resolve aren’t enough for you to take care of the audio in your program, you can also export an AAF with audio and a reference movie to Pro Tools using the Deliver page. The resulting media can be handed off to a Pro Tools-based audio facility to be worked on by a dedicated team of audio specialists, who will most likely output a stereo or 5.1 mix file that you can then reinsert in the Timeline you’re using to master the final output of your program.

For more information on exporting AAF for Pro Tools in the Deliver page, see Chapter 185, “Using the Deliver Page.”
Media Management in DaVinci Resolve refers to operations that let you copy, move, or transcode the media that’s linked to clips in your timeline, with the option to eliminate unused media in the process. Even though Media Management is only available in the Media page, it’s very typical that it be used to consolidate media from an edited timeline, or from a project nearing completion, so it’s presented here in the editing section.

Contents

- What Is Media Management in DaVinci Resolve? 799
- Media Management of Timelines Creates .drt Files 799
- File Formats That Are Compatible With Media Management 799
- Using Media Management 800
- Continuing Media Management Jobs on Error 803
- Options in the Media Management Window 803
- Options for Transcode Only 804
- File Naming When You Consolidate Media 804
What Is Media Management in DaVinci Resolve?

If you’ve edited a program within DaVinci Resolve, you can use the Media Management command to take care of a variety of tasks, including but not limited to:

- Moving all clips used in a project to a specific storage location.
- Creating a duplicate of your project’s clips that eliminates unused media in preparation for handing the media off to another facility.
- Transcoding all clips in a timeline to another format while eliminating unused heads and tails.

For example, if you’re preparing to export a project to hand off to another DaVinci Resolve user somewhere else, or even an XML or AAF to give to someone using a completely different NLE or finishing application, you can use Media Management in DaVinci Resolve to consolidate and relink the media used by the timeline you’re handing off, so the exported project or timeline references a smaller set of media.

Even if you’re not handing a project off, if you’ve ingested an enormous amount of source media into a project, and after the majority of the editing decide that you want to create a consolidated set of the media you’re using in order to lighten the project’s load in the Media Pool, you can create a duplicate of the media to reconform to, omitting unused clips and trimming the unused heads and tails of the clips you are using in the process.

But Media Management isn’t just useful for projects you’ve edited in DaVinci Resolve. For example, if you’re importing a project from another application and you’ve been given an enormous amount of source media to conform to, you may be hesitant to copy all of it to your accelerated storage volume, since (a) most of it is probably unused by the project file you’ve been given, (b) it’ll take forever to copy from the cheap USB 2 hard drive they’ve given you, and (c) it will clog up your local storage, taking valuable space away from other projects. In this case, you can use the Media Management to copy a reduced set of media files consisting of only the clips used in the current timeline of the Edit page.

Media Management of Timelines Creates .drt Files

When performing Media Management operations to copy or transcode media from a timeline, a DaVinci Resolve Timeline (.drt) file is automatically created in the same bin as the resulting media files, linked to the newly created media. This timeline can then be imported into the same or a new DaVinci Resolve project.

File Formats That Are Compatible With Media Management

No matter what you use if for, Media Management is designed to work with all video formats that have decode support within DaVinci Resolve, and is capable of outputting a few more formats than the Deliver page can. Compatible formats include but are not limited to:

- QuickTime
- MXF
- R3D
– Image-based raw media formats including CinemaDNG raw and Alexa raw
– DPX, EXR, JPEG 2000, TIFF, Cineon, and other compatible image sequence formats
– AVI
– H.264
– XAVC
– AVC-Intra

In addition, the “trim unused media” options of the Copy or Move operations are now compatible with clips that use codecs employing temporal compression, such as H.264, XAVC, and AVC-Intra, enabling you to eliminate unused media for these formats during media management without recompressing or transcoding.

Using Media Management

Using Media Management is simple.

To media manage clips and timelines in a project you’ve created:

1 Select the items you want to media manage, either clips or one or more Timelines.
2 Choose File > Media Management, and the Media Management window appears.

3 Choose the scope of the Media Management operation, shown at the top of the window. You can choose to affect the Entire Project, only one or more Timelines, or only Clips. What you had selected prior to opening the Media Management window affects the scope that is selected when you open this window, but it doesn’t limit to operation to only the selected items. So, if nothing was selected in the Media Pool, then “Entire Project” is automatically highlighted. If any clips were selected, then “Clips” is highlighted automatically. If any Timelines were selected, then “Timelines” is highlighted. However, if for whatever reason the wrong option is highlighted, you need only click the option you want to select it instead.
Next, choose which operation you want to perform:

- **Copy**: Creates duplicates of all media associated with clips or timelines at the destination.
- **Transcode**: Creates duplicates of all media associated with clips or timelines in a new format that you specify; all transcoded clips are written to the same destination.

Click the Browse button and use the File Destination dialog to choose a location for the managed media to be written. The file path of this location appears in the Media Destination field.

Choose the options associated with the operation you selected. If you choose to media manage Timelines, then a Timeline Selection option lets you choose which Timelines you want to include in this operation. The current size of the selected media is listed below, alongside an estimate of the size of the media after the operation you’ve selected. Depending on which options you select, the estimate may be larger or smaller, but this will show you if you need to change the selected options to achieve a more desirable final size.

When you’ve finished choosing options, click Start. A progress bar appears showing you how long the operation will take.

The following workflow illustrates how you can use Media Management to cut down the amount of media you need to deal with when you’re conforming a project imported from elsewhere, and you’ve been given far more media than you actually need, because you only need what’s actually in the timeline you’re importing.
To use Media Management to create a consolidated duplicate of media for a project you’re conforming:

1. Connect the portable drive containing the media to be conformed to your workstation.

2. Import the AAF or XML project file you were given into the Edit page, and conform it to the media on the portable drive you connected in step 1. You’re only doing this to identify what clips you need to media manage, not because you’ll be working off that volume.


4. Choose Timelines at the top of the window, and then open the Timeline selection section and turn on the checkbox of the timeline you want to consolidate the media for.

5. Click the Browse button and choose the volume you want to write the consolidated media to.

6. Choose the following options for consolidating the media. For this operation, you’ll want to enable:
   - Click the Browse button, and choose the accelerated storage volume you’re using for all media you’re using with DaVinci Resolve.
   - Choose the “Timelines” Media Management scope, if it’s not selected already, to manage all media from the selected timeline.
   - Choose “Copy” to make a duplicate of the media from the portable storage volume to your accelerated storage.
   - Choose “Copy and trim used media keeping 12 frame handles” if you’re comfortable with 12 frame handles.
   - Turn on “Consolidate multiple edit segments into one media file” if you don’t mind having larger media files that preserve the relationship of what clips come from which single media files. This can make grading simpler later on.
   - Turn on “Relink to new files” to automatically relink the timeline you’ve selected to the new media that’s being generated.

The Consolidate dialog lets you choose how and where to copy the trimmed media.
When you’re done choosing these settings, click Start. A progress bar appears showing you how long the operation will take.

A subset of media used by that timeline is copied to the specified directory, and a DaVinci Resolve Timeline (.drt) is automatically generated that is relinked to the timeline and clips in the Media Pool. You are now ready to continue working on the project.

**Continuing Media Management Jobs on Error**

DaVinci Resolve has a more user-friendly behavior when dealing with errors during media management operations. In previous versions, DaVinci Resolve would stop and wait for user input immediately upon encountering an error, meaning that if an error happened while you were out at lunch, nothing would happen until you came back. Now, DaVinci Resolve will skip error-flagged files and continue to perform any remaining media management to all the other clips.

**Options in the Media Management Window**

The different Media Management operations offer different options.

- **Entire Project Copy/Transcode all media**: (Not available for Timelines) Choosing this option copies the full amount of source media for every single clip in the project. If you add more media later, and then use the Copy function again, DaVinci Resolve will only copy the additional files needed to reflect the current Media Pool.

- **Destination**: Click the Browse button to choose a destination to which to copy the managed media. To create a new directory, right-click a Volume icon in the File Browser list, choose New Folder, type a name into the resulting dialog, and click OK.

- **Timeline selections**: If you’ve selected the Timelines mode of media management, you can open the Timeline Selection controls and turn on the checkbox by each timeline with media you want to include.

- **Copy/Transcode All media**: Copies all media available to that operation.

- **Copy/Transcode Used media**: Only copies media files for clips that are used in a timeline, and copies them in their entirety.

- **Copy/Transcode Used media and trim keeping x frame handles**: Only copies media files that are used in a timeline, but eliminates unused heads and tails except for user-specified handles.

- **Use project name subfolder**: Automatically creates a subfolder named for the project under the destination directory that contains all the copied or transcoded media.

- **Consolidate multiple edit segments into one media file**: This option only becomes available if you’ve selected “Copy and trim used media” if multiple clips in a timeline come from the same media file, then a single consolidated media file will be generated that contains all frames from all of these clips, along with whatever additional frames lie between them. Even though this option results in more media being copied or moved, it’s extremely useful if you’re consolidating media that you want to grade using the automatic grade linking of remote versions, as this preserves the original relationship between each Timeline clip and the source media file it’s from.
– **Preserve folder hierarchy after x folder levels:** Retains a user-specified depth of the original directory structure used by a clip’s corresponding source media file, recreating it when rendering new files for output. The number you select determines how many levels of subdirectories DaVinci Resolve will automatically create within the currently specified “Render job to” directory to match the path used by the source files. Defaults to 0, which creates no matching subdirectories. The number of path levels is defined relative to the head of each media file path.

– **Relink to new files:** (Appears for the Copy operation only) Relinks the selected clips and/or timelines to the new media you’ve created by copying, wherever you’ve copied it to.

### Options for Transcode Only

The following options appear only when Transcode is the selected Media Management operation.

– **Settings:** Exposes the default controls for the Media Management operation.

– **Video:** Exposes the video codec controls for rendering to all available video formats.

– **Audio:** Exposes the audio codec controls for rendering to all available audio formats.

### File Naming When You Consolidate Media

When you're media managing clip-based formats like QuickTime or MXF, if the “Trim Used Media” option is on, and the “Consolidate Multiple Edit Segments Into One Media File” checkbox is off, then timelines that use multiple clips derived from the same media file will generate multiple trimmed media files. To prevent these files from overwriting one another, additional characters are appended to each trimmed media file coming from the same source, which characters are used depends on the video format.

– For DPX files: _0, _1
– For R3D files: _S000.RDC, _S001.RDC
– For QuickTime files: _S000.mov, _S001.mov
The DaVinci Resolve Editor Keyboard is a combination of Keyboard and Edit Controller that greatly enhances your speed and efficiency working in DaVinci Resolve.

Contents

- Introducing the DaVinci Resolve Editor Keyboard: 806
- Navigation Using the Search Dial: 807
- Sort Media Pool Buttons: 808
- Editorial Tools: 809
- Trimming Tools: 812
- Transition Keys: 813
- Function Keys: 814
- Timecode Entry: 816
- QWERTY Keyboard Commands: 818
- Editor Keyboard Function (Fn) Key Map: 819
- Updating the Editor Keyboard Firmware: 819
Introducing the DaVinci Resolve Editor Keyboard

Using a traditional keyboard and mouse to edit with is necessary for modern computers, as the interface and operating system dictate the use of these input tools. However, the mouse can sometimes feel like an abstraction in the editing process, and the DaVinci Resolve Editor Keyboard has been designed to bring back a more “hands on” feel. This keyboard allows the convenience and power of non-linear editing with the tactile nature of the tape-based edit controllers of the past.

The DaVinci Resolve Editor Keyboard

The DaVinci Resolve Editor Keyboard has been designed to greatly accelerate Edit Page timeline navigation and to use a two-handed workflow with dedicated buttons for common functions in order to keep your mouse use to a minimum.

The main difference between using the DaVinci Resolve Editor Keyboard in the Edit page versus the Cut page is that in the Edit page the edit point is either selected manually or is set at the playhead position, not automatically set at the nearest edit point shown by the Smart Indicator, as in the Cut page.
Navigation Using the Search Dial

The most prominent feature of the DaVinci Resolve Editor Keyboard is the large Search dial on its right hand side. Primarily used for navigation, in certain circumstances this dial can also be used for the manipulation of the clips, providing an alternative to click and drag mouse input.

Source
Pressing this button instantly brings the Source Viewer into focus, allowing you to navigate through the source media.

Timeline
Pressing this button instantly brings the Timeline Viewer into focus, allowing you to navigate through the Timeline.

SHTL (Shuttle)
Puts the Search dial into Shuttle mode. Used to quickly navigate long clips or timelines. Rotating the dial left of center "rewinds" through the clip or timeline, rotating it right "fast forwards" through them. The greater the rotation from center, the faster the shuttle goes. There are hard end stops on the Search dial in Shuttle mode that indicate the maximum speed in either direction. A LED on the keyboard will illuminate to show you that this mode is selected.

Jog
Puts the Search dial into Jog mode. Used to navigate to specific frames with accuracy and precision. Traditionally, you place your finger on the Search dial dimple, and rotate it to the left to go frame by frame reverse, and to the right to go frame by frame forward. In Jog mode the hard stops are released, and the wheel rotates freely in a complete circle. A LED on the keyboard will illuminate to show you that this mode is selected.

SCRL (Scroll)
Puts the Search dial into Scroll mode. Scroll mode is essentially a “higher geared” jog mode. Rotating the wheel left reverses the play direction, while rotating it right moves forward. Scroll works in terms of seconds, rather than frames. The speed at which you rotate the Scroll dial determines how fast the playhead moves through the footage. A LED on the keyboard will illuminate to show you that this mode is selected.
Sort Media Pool Buttons

These buttons allow you to instantly re-configure the Media Pool view to arrange your clips in a specific order.

**Timecode**
Pressing this button will instantly sort all of the clips in the Media Pool by Timecode. Pressing this button again will toggle between ascending and descending order.

**CAM (Camera)**
Pressing this button will instantly sort all of the clips in the Media Pool by Camera Number order. The camera numbers can be set in the Clips Metadata Editor Field "Camera #”. This field can either be a number or a letter. Pressing this button again will toggle between ascending and descending order.

**Date/Time**
Pressing this button will instantly sort all of the clips in the Media Pool by the Date and Time that the clip was created. Pressing this button again will toggle between ascending and descending order.

**Clip Name**
Pressing this button will instantly sort all of the clips in the Media Pool by Clip Name. Please note this sorts media by the user selected Clip Name, not the media's File Name that is recorded in camera. Pressing this button again will toggle between ascending and descending order.
Editorial Tools

The DaVinci Resolve Editor Keyboard has dedicated keys to perform common editing functions, in addition to the standard QWERTY keyboard. Using the keyboard in the Edit page will also give you access to the Cut page’s custom editing tools without having to switch pages back and forth.

The Cut page Editing tools

In
This button selects the In point of a clip or timeline.

Out
This button selects the Out point of a clip or timeline.

Smart Insert
Automatically inserts an incoming clip at the playhead or selected In point on the selected track, pushing all clips to the right of the edit point forward to make room for the incoming clip.

(App) Before doing a Smart Insert, (Bottom) After inserting clip DD between clips AA and BB

Append
The position of the playhead is ignored; incoming clips are always placed after the last clip of the selected track in the Timeline.
Performing an Append edit of clip DD to the Timeline

RIPL O/WR (Ripple Overwrite)
At its simplest, Ripple Overwrite substitutes a clip in the Timeline with an incoming clip on the selected track. Place the playhead over the clip in the Timeline you wish to substitute with the one in the Source Viewer and press this button.

Performing a Ripple Overwrite to substitute an entire clip at the playhead (BB) with the incoming clip (DD)

Close Up
Lets you edit a clip into the Timeline as a zoomed-in close up to make up for a lack of actual close ups that would have been shot with either longer lenses or by moving the camera closer to the subject. This function is particularly useful when you’re working with 4K media in a 1080 timeline, or 8K media in a 4K timeline, which enables you zoom into existing wide shots to create medium shots, or medium shots to create close up shots, with no loss of quality.
Performing this edit adds the incoming clip as an approximate 150% scaled close up, and if a face or faces are found, automatically re-positions the face in the frame. Which frame of the Timeline the incoming clip aligns with depends on the following:

– If no In or Out points are set on the timeline, the incoming clip aligns with the Timeline playhead as the In point.
– The incoming clip aligns with a timeline In point if one has been set.
– The incoming clip’s Out point will align with a timeline Out point if one has been set without an In point. This “backtimes” the clip.
Place On Top

Lets you edit the incoming clip as a superimposition above whatever other clips are in the Timeline; the incoming clip is always placed on top, so if there are clips in Tracks 1, 2, and 3, the incoming clip is automatically placed on Track 4, regardless of which track is selected. The frame the incoming clip aligns with depends on the following:

- The incoming clip aligns to the playhead if no timeline In or Out points have been defined.
- The incoming clip aligns with a timeline In point if one has been set.
- The incoming clip’s Out point will align with a timeline Out point if one has been set without an In point. This “backtimes” the clip.

SRC O/WR (Source Overwrite)

This edit requires overlapping timecode in multiple clips to work properly, such as when recording synced timecode to multiple cameras during a multi-cam shoot. If there is no overlapping timecode, this edit does nothing.

Press this button to automatically place a source clip with a marked In/Out region on top of a clip in the Timeline so that its timecode syncs with the timecode of the timeline clip, when you don’t know exactly how much of the incoming source clip you want to edit into the Timeline, and you just want it synced appropriately.
Trimming Tools

Several of the most powerful features of the DaVinci Resolve Editor Keyboard involve the intuitive trimming controls afforded by the Search dial.

Trim In
When this key is pressed and held, it lets the user trim the In point of the clip in the Timeline under the playhead, by simply rotating the Search dial back and forth. The trim point is highlighted in green. Release the key to confirm the edit.

Trim Out
When this key is pressed and held, it lets the user trim the Out point of the clip in the Timeline under the playhead, by simply rotating the Search dial back and forth. The trim point is highlighted in green. Release the key to confirm the edit.

Roll
When this key is pressed and held, it lets the user trim the nearest edit point to the clip under the playhead, and roll the edit point back and forth between the clips by simply rotating the Search dial. The trim point is highlighted in green. Release the key to confirm the edit.

SLIP SRC (Slip Source)
When this key is pressed and held, it allows the user to slip the footage of the clip to the left of the nearest edit point to the playhead back and forth by moving the Search dial. A four way multiview will show the In and Out points for both source and destination clips as you slip. The clip that will slip will be highlighted in orange. Release the key to confirm the edit.

SLIP DEST (Slip Destination)
When this key is pressed and held, it allows the user to slip the footage of the clip to the right of the nearest edit point to the playhead back and forth by moving the Search dial. A four way multiview will show the In and Out points for both source and destination clips as you slip. The clip that will slip will be highlighted in orange. Release the key to confirm the edit.

Trim Editor
This key does not function in the Edit page.
Transition Keys

This set of keys provide immediate shortcuts to the most commonly used transition commands.

Cut
This key will change any existing transition to a simple cut at the Timeline edit point under the playhead. It will not add a new cut at the playhead position. To do this use the Split Clip (Command-\) function instead.

DIS (Dissolve)
This key will add a one second dissolve centered between the two shots at the Timeline edit point under the playhead. If there is another transition already present there, it will replace it.

SMTH CUT (Smooth Cut)
This key will add a Smooth Cut transition centered between the two shots at the Timeline edit point under the playhead. If there is another transition already present there, it will replace it.

Smooth Cuts are special-purpose transitions designed to make short jump cuts in the middle of a clip unnoticeable. This is done by using optical flow processing to match the same features on either side of a cut in order to automatically morph a subject from one position to another over the duration of the transition.

The Smooth Cut effect works best on clips such as sit-down interviews and close-up head shots with a minimum of background and subject motion, and where the subject’s position on either side of the cut is not significantly different. A good example of when Smooth Cut is effective is when you’re cutting pauses, partial repeats, filler sounds such as “um” or “you know,” or other speech disfluencies out of an interview clip to tighten the dialog, and you want to eliminate the little “jump” that occurs at the cut without having to cut away to B-roll. Applying a short two or four frame Smooth Cut transition to the edit can make this kind of edit invisible, as long as the speaker doesn’t change position significantly during the cut. The more motion there is in the background of the shot, and the more the speaker changes position, the harder it will be to get a useful result using Smooth Cut. Although the default duration for any transition is one second, you’ll find that Smooth Cut transitions may work much better when they’re short; 2- to 6-frame Smooth Cut transitions often work best to disguise jump cuts.

TRANS DUR (Transition Duration)
Holding down this key when a transition is under the playhead will allow you to change the duration of the transition using the Search dial. Turning the dial left will shorten the transition, and right will lengthen it. Once the duration is correct, release the button.
The function keys of the DaVinci Resolve Editing Keyboard are by default mapped directly to their DaVinci Resolve commands. If you wish to use them as regular function keys (f1, f2, f3, etc.) you can hold the Fn key down and press the appropriate function key.

Sync Bin (F1)
This key does not function in the Edit page.

Insert Black (F2)
Pressing this button will add two seconds of black (via the solid color generator) to the selected track. This is used as filler for transitions where you want to replace the "nothing" of the empty timeline with an actual media clip. This function does not use the Smart Indicators and will insert exactly at the playhead position.

Freez (Freeze Frame) (F3)
Pressing this button will freeze the exact frame of the clip that is under the playhead for the remaining duration of that clip.

TRANS (Transition) (F4)
This key does not function in the Edit page.

Pic in Pic (Picture in Picture) (F5)
This key does not function in the Edit page.

Swap (F6)
Press and hold the Swap button, and using the Search dial, move the clip under the playhead earlier or later in the Timeline, effectively swapping the moving clip with the one you are scrolling over.

**TIP:** You can easily move entire scenes back and forth in your timeline by Command Selecting the all clips in the scene, holding down the Swap key (f6), and rotating the Search Dial. When the scene is in its correct place, release the key. (Edit page only).
**Video Only (F7)**

This button locks the audio tracks in place on the Timeline so that all further editing is done with the video tracks only. Press this button again to release the audio tracks, or press the Audio Only button. (At the time of this writing, this feature had not been implemented yet.)

**Audio Only (F8)**

This button locks the video tracks in place on the Timeline so that all further editing is done with the audio tracks only. Press this button again to release the video tracks, or press the Video Only button. (At the time of this writing, this feature had not been implemented yet.)

**Insert (F9)**

An Insert edit splits whatever media is already in the Timeline at the position of the playhead and pushes that media to the right to make room for the incoming clip.

**O/WR (Overwrite) (F10)**

You can use the F10 key to perform an Overwrite edit, which overwrites a section of the Timeline with the incoming clip, without moving other clips in any way. The frame the incoming clip aligns with depends on the following:

- The incoming clip aligns with the playhead if no timeline In or Out points have been defined.
- The incoming clip aligns with a timeline In point if one has been set.
- The incoming clip's Out point will align with a timeline Out point if one has been set without an In point. This "backtimes" the clip.

**REPL (Replace) (F11)**

Replace edits are a unique three-point edit type that aligns the frame at the Source Viewer playhead with the frame at the Timeline playhead when the edit is executed. This is the fastest edit type to use when you need to align an action at a specific frame of video, or a sound at a specific frame of audio, to a particular frame's action or sound in the video or audio of the Timeline.

The fastest way of using the Replace edit is to not bother setting either In or Out points in the Source Viewer, and to either use the duration of an existing clip intersecting the Timeline to define the edit, or a pair of timeline In/Out points specifying either a section of a clip you want to overwrite, or an empty section of the Timeline to which you want to edit.

Replace edits do not ripple the Timeline.

**Fit to Fill (F12)**

Fit to fill edits are the only edit type that actually use all four edit points, and it's the only edit type that retimes clips at the same time as they're being edited. By setting In and Out points in the incoming source clip, and another pair of In and Out points in the Timeline, you can stretch or compress the timing of the specified range of source media to cover the entire specified range of the Timeline. In the process, the speed ratio of the clip changes so the clip plays in either fast or slow motion.

Fit to fill edits are especially valuable when you have a source clip in which the action is slightly slow, and you just want to speed it up by squeezing it into a shorter duration of the Timeline. They're also incredibly handy in situations when you have a gap in an edited sequence of clips to fill with a source clip that's just not long enough, but in which slightly slower motion won't be noticeable.

Fit to fill edits do not ripple the Timeline.
Ripple Del (Ripple Delete)
Pressing this key will delete the selected clip or clips, and then close any gaps that occur by rippling the Timeline to the left.

Timecode Entry
This numerical keypad has many timecode-specific keys that allow you to input these values directly into DaVinci Resolve to navigate to specific points in the Timeline, or move forward and backward in the Timeline by specific increments.

How to Enter Timecode Values
When entering timecode, type each pair of hour, minute, second, and frame values from left to right, with a period representing a pair of zeros for fast entry. The numbers you enter appear in the timecode field at the upper right-hand corner of the Viewer with focus. When you’re finished typing, press the Return key to execute the Timecode command. The rules for timecode entry are as follows:

- The right-most pair of timecode values (or period) you enter is always the frame number.
- A period to the left or to the right of any number you type is considered to be a pair of zeroes.
- A single period between two numbers is considered to either be a single zero, or ignored if it’s between two pairs of numbers.
- Any untyped pairs of values to the left of what you enter are assumed to be whatever those values were prior to the timecode you entered; this makes it easy to type partial timecode values even when the Timeline starts at hour one.
- It’s not necessary to enter colons or semicolons.

Absolute Timecode Entry
Absolute timecode is entered simply by typing in a timecode value. So long as no clips or edit points are selected when you press the Return key, the playhead will move to that timecode value. If an edit point or clip is selected, those will be moved or trimmed to the corresponding timecode value, if possible.
Here are some examples of absolute timecode entry using this method:

<table>
<thead>
<tr>
<th>Original TC Value</th>
<th>User-Typed Value</th>
<th>New TC Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>01:10:10:10</td>
<td>15245218</td>
<td>15:24:52:18</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>2...</td>
<td>01:02:00:00</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>15</td>
<td>01:10:10:15</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>12</td>
<td>01:10:10:12</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>1.2</td>
<td>01:10:01:02</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>1115...</td>
<td>11:15:00:00</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>23...</td>
<td>23:00:00:00</td>
</tr>
</tbody>
</table>

Relative Timecode Entry

Relative timecode is entered by starting the timecode value with a plus (+) or minus (–). Adding a plus results in the value you type being added to the current timecode value for purposes of offsetting the playhead or moving a selection. Adding a minus will subtract the value you type from the current timecode value.

Here are two examples of relative timecode entry:

<table>
<thead>
<tr>
<th>User-Typed Value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>+20.</td>
<td>00:00:20:00 is added to the current timecode value.</td>
</tr>
<tr>
<td>+3...</td>
<td>00:03:00:00 is added to the current timecode value.</td>
</tr>
<tr>
<td>-5</td>
<td>00:00:00:05 is subtracted from the current timecode value.</td>
</tr>
</tbody>
</table>

F/TC (Frames/Timecode)

This button toggles between timecode (HH:MM:SS:FF) and frame count (23, 48, etc.) entry using the numerical keypad. For example, if you wanted to move forward 200 frames, you can press this key and then enter +200 and press the Enter key.

Dur Enter (Duration Enter)

Press this key to quickly change the duration of a transition or clip length to the exact number that you typed in.

00

This button adds two zeros to the timecode input rather than a single zero, to make numerical entry faster.
QWERTY Keyboard Commands

The standard QWERTY shortcut keys have been modified slightly.

Retime (R)
The Retime controls have been mapped to the letter R on the keyboard. This works both in the Cut and Edit pages.

Full View (P)
The full screen Viewer has been mapped to the letter P on the keyboard, and works in the Cut, Edit, Color and Fusion pages.

Hand (H)
This key allows you to select Hand or Pointer mode on the Viewer for repositioning of titles. This works on the Edit page only. (At the time of this writing, this feature had not been implemented yet.)

Zoom (Z)
This key will zoom to fit your media clip in the Viewer. This works in the Cut, Edit, and Color pages.

Autocolor (C)
This key will perform the Autocolor function on the clip that is underneath the playhead, or the selected timeline clip.

Using the Function (Fn) Key on the Editor Keyboard
There are three types of key actions mapped to the DaVinci Resolve Editor Keyboard. The Function (Fn) key in the lower left of the keyboard toggles these modes and each type of key action modifies the resulting commands. These key actions give you access to standard computer functions in your native OS.

- Key Press: Simply pressing the key once.
- Fn + Key Press: Holding down the Fn key and then pressing another key.
- Tap Fn + Hold: Pressing the Fn Key once, then pressing Fn again and holding it down, then pressing another key. This is a total of three key presses.
## Editor Keyboard Function (Fn) Key Map

<table>
<thead>
<tr>
<th>Key Press</th>
<th>Fn + Key Press</th>
<th>Tap Fn + Hold</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYNC BIN</td>
<td>F1</td>
<td>DECREASE SCREEN BRIGHTNESS</td>
</tr>
<tr>
<td>INSERT BLACK</td>
<td>F2</td>
<td>INCREASE SCREEN BRIGHTNESS</td>
</tr>
<tr>
<td>FREEZ</td>
<td>F3</td>
<td>SHOW ALL WINDOWS</td>
</tr>
<tr>
<td>TRANS</td>
<td>F4</td>
<td>SHOW ALL APPLICATIONS</td>
</tr>
<tr>
<td>PIC IN PIC</td>
<td>F5</td>
<td>DECREASE KEYBOARD LED BRIGHTNESS</td>
</tr>
<tr>
<td>SWAP</td>
<td>F6</td>
<td>INCREASE KEYBOARD LED BRIGHTNESS</td>
</tr>
<tr>
<td>VIDEO ONLY</td>
<td>F7</td>
<td>PREVIOUS TRACK</td>
</tr>
<tr>
<td>AUDIO ONLY</td>
<td>F8</td>
<td>PLAY/PAUSE</td>
</tr>
<tr>
<td>INSERT</td>
<td>F9</td>
<td>NEXT TRACK</td>
</tr>
<tr>
<td>O/WR</td>
<td>F10</td>
<td>MUTE</td>
</tr>
<tr>
<td>REPL</td>
<td>F11</td>
<td>DECREASE VOLUME</td>
</tr>
<tr>
<td>FIT TO FILL</td>
<td>F12</td>
<td>INCREASE VOLUME</td>
</tr>
<tr>
<td>UP ARROW</td>
<td>PAGE UP</td>
<td>PAGE UP</td>
</tr>
<tr>
<td>DOWN ARROW</td>
<td>PAGE DOWN</td>
<td>PAGE DOWN</td>
</tr>
<tr>
<td>LEFT ARROW</td>
<td>HOME</td>
<td>HOME</td>
</tr>
<tr>
<td>RIGHT ARROW</td>
<td>END</td>
<td>END</td>
</tr>
<tr>
<td>HOME</td>
<td>END</td>
<td>END</td>
</tr>
<tr>
<td>KEYPAD ENTER</td>
<td>CALCULATOR</td>
<td>CALCULATOR</td>
</tr>
<tr>
<td>DELETE</td>
<td>FORWARD DELETE</td>
<td>FORWARD DELETE</td>
</tr>
<tr>
<td>CAM</td>
<td>PRINT SCREEN</td>
<td>PRINT SCREEN</td>
</tr>
<tr>
<td>TIMECODE</td>
<td>PAUSE</td>
<td>PAUSE</td>
</tr>
<tr>
<td>DUR ENTER</td>
<td>NUM LOCK</td>
<td>NUM LOCK</td>
</tr>
</tbody>
</table>

## Updating the Editor Keyboard Firmware

From time to time, Blackmagic updates the functionality of the Editor Keyboard through firmware changes. New firmware can be checked for and installed by opening the separate DaVinci Control Panels Setup utility that is installed by default with DaVinci Resolve.
This chapter covers how to browse for and apply effects to clips in the Timeline, how to copy them from clip to clip, how to remove them, and how to edit them in the Inspector once they’ve been added. For more information about the specific Resolve FX that are available, see Part 12, “Resolve FX.”

Contents

Using the Effects Library 822
The Toolbox 822
Open FX 823
Audio FX 823
Effects Library Favorites 823
Converting Fusion Compositions to Edit Effects 824
Seeing Effects in the Timeline 824
Using the Inspector 824
Inspector Effects Controls 825
Adding Filters to Video Clips 826
Render in Place 829
Adjusting Multiple Clips at the Same Time 830
Adjustment Clips 831
Paste Attributes 832
Keyframe Options for Pasting Keyframed Attributes 832
Option to Ripple the Timeline for Pasting Speed Effects 832
Remove Attributes 833
Using the Effects Library

All effects that you can add to your edit, including filters, transitions, titles, and generators, are found in the Effects panel. The Effects panel shows a hierarchical list of all of the different transitions, title effects, generators, and filters that are available, sorted by category.

To preview a video effect before placing it on a clip, ensure that “Hover Scrub Preview” is checked in the Effects option menu, then simply hover your pointer over any thumbnail in the Effects tab and move it across the thumbnail. The effect will preview in the Viewer using its default parameters, and scrub through the clip that is selected in the Timeline. If no clip is selected then it will use the clip currently under the playhead.

To activate a specific video effect on a clip, simply drag the thumbnail of the selected effect to a clip on the Timeline. You can also double click the thumbnail, or drag an effect directly into the Inspector to apply the effect to the selected clip. To adjust the effect’s parameters, open the Effects tab in the Inspector.

The Toolbox

All of the video and audio transitions, titles, and generators that ship along with DaVinci Resolve:

- **Toolbox**: Exposes all transitions, titles, generators, and effects at once.

- **Video Transitions**: Contains all of the built-in transitions that are available from DaVinci, organized by category. At the bottom of the list, a User category shows presets that you’ve saved. You can drag any video transition to any edit point in the Timeline that has overlapping clip handles to add it to your edit; you have the option to drag the transition so that it ends on, is centered on, or starts on the edit point. For more information, see Chapter 49, “Using Transitions.”

- **Audio Transitions**: Contains audio transitions for creating crossfades.

- **Titles**: Titles can be edited into the Timeline like any other clip. Once edited into the Timeline, you can edit the title text and position directly in the Timeline Viewer, or you can access its controls in the Inspector for further customization.

- **Generators**: Generators can also be edited into the Timeline like any other clip. Selecting a generator and opening the Inspector lets you access its controls for further customization. You can also choose a standard duration for generators to appear within the Editing panel of the User Preferences.

- **Effects**: Effects are essentially placeholders in the Timeline that allow for more specialized compositing in Fusion, or that let you modify the underlying tracks with an adjustment clip.
**Open FX**

DaVinci Resolve supports the use of third-party Open FX filters, transitions, and generators in the Edit page. Once you install these effects on your workstation, they appear in this section of the Effects Library, organized by type and group depending on the metadata within each effect.

- **Open FX:** Exposes all Resolve FX and third-party Open FX installed on your workstation at once.
- **Filters:** Contains the Resolve FX filters that ship with DaVinci Resolve, as well as any third-party OFX plug-ins you’ve installed on your workstation. Filters can be dragged onto video clips to apply an effect to that clip. Once applied, filters can be edited and customized by opening the Open FX panel of the Inspector.
- **Generators:** Contains any third-party OFX generators you have installed on your workstation. Can be edited into the Timeline just like the native generators that ship with DaVinci Resolve, but they also expose an Open FX panel next to the Transition panel in the Inspector, where you can customize settings that are unique to that transition.
- **Transitions:** Contains any third-party OFX transitions you have installed on your workstation. OFX transitions can be used similarly to any other transition, but they also expose an Open FX panel next to the Transition panel in the Inspector, where you can customize settings that are unique to that transition.

**Audio FX**

On all platforms, DaVinci Resolve supports a set of built-in Fairlight FX, a native audio plug-in format that makes various audio tools and effects available on macOS, Windows, and Linux. On macOS and Windows, DaVinci Resolve supports the use of third-party VST audio plug-ins, which includes most of the professional third-party tools and effects used in the audio postproduction industry. On macOS, DaVinci Resolve supports Audio Unit (AU) audio plug-ins. Once you install these effects on your workstation, they appear in this panel of the Effects Library. Audio plug-ins let you apply effects to audio clips or entire tracks’ worth of audio, to add creative qualities such as echo or reverb, or to take care of mastering issues using noise reduction, compression, or EQ.

**Effects Library Favorites**

You can click on the far right of any transition, title, or generator flag that effect with a star as a favorite effect. When you do so, the favorited effects appear in a separate Favorites area at the bottom of the Effects Library Bin list.

Stars indicate a flagged favorite effect; all favorites are currently filtered.
Converting Fusion Compositions to Edit Effects

If you have created a Fusion Composition that you would like to use across a number of projects, you can now save it to the Effects toolbox in the Edit page. This allows easy access to the effect from the Edit page, and simple application to video clips in the Timeline.

To convert a Fusion composition to an Edit effect:
1. Export the composition as a macro in Fusion, by right clicking on a node and selecting Create Macro from the contextual menu.
2. Save the macro file (.setting) to the following directory:
   - MacOS: /Library/Application Support/Blackmagic Design/DaVinci Resolve/Fusion/Templates/Edit/Effects
   - Windows: C:\ProgramData\Blackmagic Design\DaVinci Resolve\Fusion\Templates\Edit\Effects
   - Linux: /opt/resolve/Fusion/Templates/Edit/Effects

The effect will now be available as a drag and drop effect in the “Fusion Effects” section of the toolbox in the Effects Library on the Edit page.

Seeing Effects in the Timeline

When you apply any kind of an effect to a clip in the Timeline, be it an adjustment in the Inspector, a speed effect, a plug-in you’ve applied, etc., clips with that effect appear a darker shade of whatever color they are to show you there’s an effect applied. Removing all effects from a clip (for example, using the Remove Attributes command) returns that clip to its original color. This makes it easy to see, at a glance, which clips have effects, and which clips don’t.

Using the Inspector

Once you’ve added effects to a timeline, the Effects Inspector is where you can edit their parameters. The Inspector is the central area for editing all of the settings relating to filters, compositing, sizing, titling, transitions, generators, and effects of all kinds. Many of the instructions in this section require the use of the Inspector, which can be opened or closed by clicking the Inspector button at the far right of the Edit and Cut page toolbars, or by double-clicking a transition or generator in the Timeline.
The Inspector displays different parameters depending on what you’ve selected in the Timeline; (left) parameters of a clip, (right) parameters of a title.

There are three ways that the parameters of clips in the Timeline can be displayed in the Inspector:

- If no clips are selected in the Timeline, then the clip in the highest auto-select-enabled track that intersects the playhead will have its parameters shown in the Inspector.

- The Inspector always shows the parameters of one or more selected items in the Timeline, which will override the clip in the highest track that intersects the playhead, if necessary. Changing the selection changes which parameters are displayed, and the parameters you edit in the Inspector only alter the currently selected clip. If multiple clips are selected, the Inspector displays “Multiple Clips” and allows you to adjust the parameters of all selected clips at the same time.

- Choosing Timeline > Selection Follows Playhead sets DaVinci Resolve to always select whichever clip intersects the playhead in the Timeline. The result is that the Inspector always displays the parameters of the clip at the playhead, with the added bonus that the clip at the playhead is also selected for other editorial functions. If there are multiple superimposed clips intersecting the playhead all at once, the topmost video clip with an enabled Auto Select control will be selected, thus exposing its parameters in the Inspector, and all other clips will be ignored.

**Inspector Effects Controls**

Different Effects clips in the Timeline expose different controls. Whichever panels are exposed, parameters within each panel are organized into groups, with a title bar providing the name of that group, along with other controls that let you control all parameters within that group at the same time.
These controls include:

- **Enable button**: A toggle control to the left of the parameter group’s name lets you disable and re-enable every parameter within that group at once. Orange means that track’s enabled. Gray is disabled.

- **Parameter group title bar**: Double-clicking the title bar of any group of parameters collapses or opens them. Even more exciting than that, Option-double-clicking the title bar of one parameter group collapses or opens all parameter groups at once.

- **Keyframe and Next/Previous Keyframe buttons**: This button lets you add or remove keyframes at the position of the playhead to or from every single parameter within the group. When the button is highlighted orange, a keyframe is at the current position of the playhead. When it’s dark gray, there is no keyframe. Left and right arrow buttons let you jump the playhead from keyframe to keyframe for further adjustment.

- **Reset button**: Lets you reset all parameters within that group to their default settings.

## Adding Filters to Video Clips

DaVinci Resolve supports both built-in Resolve FX and third-party OFX plug-ins to create various effects. These effects can be applied both to clips in the Edit page, and to nodes in the Color page. This section shows how to apply, edit, and remove these filters in the Edit page. For more information about using video effects in the Color page, see Chapter 149, “Using Open FX and Resolve FX.”

For a detailed explanation of each of the Resolve FX plug-ins that accompany DaVinci Resolve, see Part 12, “Resolve FX.”

### Methods of applying video filters in the Edit page:

- **To apply a video filter to a clip**:
  - Drag any filter from the Effects Library onto the clip in the Timeline you want to apply it to.
  - Double Click the filter in the Effects Library to apply it to the selected clip.
  - Drag the Filter from the Effects Library to the Inspector to apply it to the selected clip.
  - Drag the Filter from the Effects Library to the Viewer to apply it to the clip being viewed.

- **To apply a video filter to multiple clips**: Select all of the clips you want to apply a filter to in the Timeline, and then drag any filter from the Open FX category of the Effects Library onto any of the selected clips. This is undoable.
Applying a video filter to a single clip in the Timeline

To edit a clip’s video filters:

- Select that clip and open the Inspector’s Effects tab. The effects will be further sub-grouped by type: Fusion, Open FX, or Audio. If a clip does not have any effects assigned to it, this panel will be dimmed.


Some video filters have custom onscreen controls that can be modified in the Viewer. These can be exposed in the Edit page using the OFX mode of the Viewer.

Turning on the onscreen controls for Resolve FX in the Edit page Timeline Viewer
Once enabled, the OFX onscreen controls appear in the Viewer.

Many audio filters expose custom controls that appear in a floating window.

**To expose a filter’s custom controls:**
- Open the parameters if they’re not open already by double-clicking that filter’s title bar. A button should appear at the top of the parameters for filters that have custom UI. Clicking this button opens a floating window with all the custom controls. When you’re finished adjusting the custom controls, close the window.

![The Fairlight FX Noise Reduction custom UI interface](image)

**Methods of working with video filters in the Inspector:**
- **To rearrange the order of multiple video filters applied to a clip:** Click the move up or move down buttons in any filter’s title bar, to the left of each filter’s Trash Can button.
- **To disable or re-enable a filter:** Click the toggle control at the far left of each filter’s title bar. Orange means that track’s enabled. Gray is disabled.
- **To remove a filter:** Click the Trash Can button.
- **To reset a filter:** Click the Reset button at the far right of the filter’s title bar.
- **To open or collapse a filter’s parameters:** Double-click the title bar.
- **To open or collapse the parameters of all filters:** Option-click the title bar.
Once applied to a clip, video filters can also be keyframed or automated just like any other Inspector setting, to create dynamic effects that change over time.

Render in Place

Render in Place allows you to render and bake in all effects that are applied to a single clip on the Edit page Timeline. This command, which only works in the Edit page, creates an entirely new media file that replaces the original clip on the Timeline. This new file is created in the same directory as the original source file and is added to the Media Pool automatically.

You can use Render in Place to improve the playback performance of a computationally intensive clip, or use it to create a new high-quality master media with effects that have been finalized baked in. For example, perhaps you have created a clip with a complicated speed ramp, and you want to pass it to another editor or vfx artist in a round-trip rendering scenario, but you are worried about how other programs may interpret the speed effects. In this scenario you could render the clip in place at master quality, and then render and deliver the program.

Render in Place is not a one way operation. Afterwards, you have the option to “Decompose to Original” to bring back the original clip with the original effects, if you need to make a change because the clip was not really as finalized as you were hoping.

To Render in Place:

1. Select one or more clips on the Edit Page timeline. Selecting multiple clips results in each clip being individually rendered in place, but as a batch operation.

2. Right-click the selection, and choose “Render in Place” from the contextual menu.

3. Choose the appropriate Render Clip Options, and then click the “Render” button.
   - **Start Timecode**: Sets the starting timecode value for the clip.
   - **Format**: Selects the media file format.
   - **Codec**: Selects the video codec.
   - **Type**: Specifies the compression parameters of the selected codec.
   - **Include Handles**: Gives you the option to specify the number of frames before and after the clip In/Out points to be rendered.
   - **Include Video Effects**: Turn on this checkbox to bake in all effects that have been applied to the clip, including Fusion compositing, sizing, Open FX or Resolve FX, speed effects, and grading. Turning this checkbox off renders the clip with speed effects baked in, but no other effects applied.

![The Render in Place options](image)

4. Use the File dialog that appears to choose where you want to save the resulting media. Choose a location and click Open.
A progress bar appears to show you how long this will take. When finished, your new media is saved in the designated location, added to the Media Pool, and will replace each corresponding source clip on the Timeline.

If you’ve used Render in Place and end up having buyer’s remorse, or a late-breaking change comes back to you later, you can easily decompose to the original clip with its editable effects to make the change.

**To Decompose to Original:**
1. Select one or more clips that have already been Rendered in Place, on the Edit Page timeline.
2. Right-click the selection, and choose “Decompose to Original” from the contextual menu.

The original clip, along with all of its editable effects, will be returned to the Timeline. The new media created in the Render in Place process will not be deleted from the source folder, nor will it be removed from the Media Pool. It is effectively a new clip.

### Adjusting Multiple Clips at the Same Time

There’s an easy way to make adjustments to the Inspector parameters of multiple clips at the same time, without needing to use Paste Attributes (described later in this chapter). All you need to do is simultaneously select every clip you want to alter, and then modify the parameter in the Inspector that you want to change. As a result, every selected clip will be adjusted by the same amount. This works for compositing effects, transforms, text parameters, filters, and audio settings, just about anything that can be simultaneously exposed in the Inspector for multiple selected clips.

When you select multiple clips, the Inspector will display “Multiple Clips” as the title. If each of the selected clips have different values in the parameter you’re adjusting, that parameter will have two dashes in the value field. There are two ways you can make adjustments to multiple clips:

- If you want to make a relative adjustment to all selected clips while keeping their original offsets from one another, then drag the virtual slider in the parameter field which will display a + or – before however many units your adjustment is.

- However, if you want to set all selected clips to the same value, you can double-click in the number field, type the value, and press Return.

![Making a relative adjustment of plus 4.9 in the Rotation Angle of all selected clips](image)
Adjustment Clips

You can also apply all sorts of effects to multiple clips in the Timeline using Adjustment clips, available from the Effects bin of the Toolbox in the Effects Library. When an Adjustment Clip is superimposed above one or more clips in the Timeline, any filters or other effects that are applied to the Adjustment clip are also applied to all clips underneath it.

Adjustment clips can be used to apply the following types of effects:

– Resolve FX and Open FX plug-ins
– Inspector parameters including Composite, Transform, Cropping, and Dynamic Zoom
– Fusion page effects
– Color page grading and sizing

Adjustment clips are a fast and easily revised way to apply one or more effects and grades to a range of clips. Adjustment clips that are difficult to playback in real time can be rendered to cache, just like any normal video clip. Adjustment Clips can be named using the Inspector. To store an Adjustment clip, simply drag it from the Timeline to the Media Pool. You can then manage the Adjustment clip just like any other media type.
Paste Attributes

You can copy and paste video and audio attributes, as well as color corrections, from one clip to multiple clips using the Paste Attributes command. This is a fast way to apply video and audio adjustments and effects from one clip to many others in the Timeline.

**To copy attributes:**

1. Select a clip with attributes you want to apply to other clips, and press Command-C.
2. Select one or more other clips to paste to.
3. Choose Edit > Paste Attributes (Option-V), or right-click one of the selected clips and choose Paste Attributes from the contextual menu.
4. When the Paste Attributes window appears, click the checkboxes of each of the attributes you want to paste, and click Apply when you’re done.

The Paste Attributes window shows you the clip you’re copying from and the clip(s) you’re pasting to at the top, and provides checkboxes you can use to select which attributes you’d like to paste.

**Keyframe Options for Pasting Keyframed Attributes**

A pop-up menu below lets you choose how you’d like to apply any keyframes that are part of the attributes being pasted; the options are Maintain Timing or Stretch to Fit.

**Option to Ripple the Timeline for Pasting Speed Effects**

When using Paste Attributes to copy speed effects from one clip to another, the Ripple Sequence checkbox lets you choose whether or not the pasted speed effect will ripple the Timeline.
Remove Attributes

You can also eliminate specific attributes from one or more clips, using a window that’s the opposite of the Paste Attributes window.

To remove attributes:

1. Select one or more other clips that have effects you want to remove.
2. Choose Edit > Remove Attributes, or right-click one of the selected clips and choose Remove Attributes from the contextual menu.
3. When the Remove Attributes window appears, the checkboxes of effects that can be removed are enabled, so turn on attributes you want to remove.
4. (Optional) If one of the attributes you’re removing is a retime effect, use the Ripple Sequence checkbox to choose whether or not the Timeline will ripple as a result.
5. Click Apply when you’re done.
Chapter 49

Using Transitions

Transitions are the connective tissue binding together moments requiring a more significant way of changing from one image to the next than a simple cut. This chapter shows the many ways you can add and edit transitions in your program.

Contents

Working With Transitions 835
Previewing Transitions 835
Adding and Editing Transitions 836
Adding Transitions When There’s Not Enough Handles 837
Adding Transitions By Dragging to Create Overlap 838
Transition Properties in the Inspector 839
Using Transition Curves in the Edit Page 840
Favorite Transitions 841
Changing the Standard Transition 841
Creating Transition Presets 842
Changing Transitions to Fusion Compositions 842
Video Transitions 843
Dissolve 843
Iris 844
Motion 845
Shape 846
Wipe 847
User Transitions 847
Fusion Transitions 848
Resolve FX Transitions 848
Burn Away Transition 848
DCTL Transition 850
Audio Transitions 850
OpenFX Transitions 850
Working With Transitions

Transitions provide another way of bridging the change from one clip to another, and are often used to indicate a change in time or location when changing scenes. DaVinci Resolve supports a variety of transitions ranging from various forms of the traditional cross dissolve to different types of wipes, allowing for great flexibility when finishing creative edits. In addition, DaVinci Resolve supports third-party OpenFX transitions that you install on your system. Transitions are applied at edit points, and appear as editable objects in the Timeline.

![Video and audio transitions in the Timeline](image)

Previewing Transitions

To preview a transition before you place it into the Timeline, ensure that “Hover Scrub Preview” is checked in the Transitions option menu, then simply hover your pointer over any transition in the Transitions tab (Cut page) or Effects Library Toolbox (Edit page) and move it across the thumbnail. The transition will preview in the Viewer using the two clips nearest the smart indicator in the Cut page, or the two clips nearest the the playhead in the Edit page.

![Scrubbing over a Transition Thumbnail previews the transition in the Viewer.](image)
Adding and Editing Transitions

The following procedures describe how to work with add and edit transitions in the Timeline using both the mouse and keyboard shortcuts.

Methods of adding transitions using the mouse:

- **To add a transition by dragging it from the Effects Library:** Drag a video transition from the Effects Library to an edit point in the Timeline so that it’s centered at, ends at, or starts at the edit point. If there is no overlap between the heads and tails of the two clips, you may not be able to add a transition where you want.

- **To add a transition by double-clicking its icon in the Effects Library:** Double click a transition’s icon in the Effects Library to apply that transition to the edit point indicated by the smart indicator (Cut page), or at the end of the clip that is currently under the playhead (Edit page).

- **To add a transition by clicking the Transition Alignment icons:** In the Cut page, at the bottom of the Transitions Library, are three Transition Alignment icons. Clicking any of these icons applies the selected transition to the edit point indicated by the smart indicator, with the specified alignment.

- **To add a transition using the Effects Library contextual menu:** Select one or more edit points (one per track), then right-click a video transition in the Effects Library and choose Add to Selected Edit Points. That transition will be added to every selected edit point at once.

Methods of adding transitions using keyboard shortcuts:

- **To add a video+audio transition using the keyboard:** Select one or more edit points using the Selection tool, or move the playhead near an edit you want to select and press V to select it, then press Command-T (Timeline > Add Transition) to add the standard transition. Transitions are added using the “Standard transition duration” as specified in the Editing panel of the User Preferences, which defaults to one second, or however long the overlapping handles of the selected edit point allow.
To add a video or audio-only transition using the keyboard: Select one or more edit points, and press Option-T (Timeline > Add Video Only Transition) to add only a video transition, or Shift-T (Timeline > Add Audio Only Transition) to add only an audio transition. Transitions are added using the “Standard transition duration” as specified in the Editing panel of the User Preferences, which defaults to one second, or however long the overlapping handles of the selected edit point allow.

To add a transition with specific alignment using the keyboard: Select an edit, press the U key to choose the start, center, or end of the edit, then press Command-T. The standard transition will be added with its alignment based on the edit selection; selecting the start of the edit places a transition that ends on the edit; selecting the end of the edit places a transition that starts on the edit, and choosing the center of the edit places a transition that is similarly centered.

Methods of moving and duplicating transitions:

- To move a transition from one edit to another: Select a transition, then drag it to another edit point.
- To copy a transition from one edit to another: Select a transition, then option-drag it to another edit point.
- Copying a transition from one edit to multiple edit points:
  - Right-Click on the transition you want to duplicate, and select copy (or hit Command-C).
  - Hold down the Command-Key, and select all the edit points in the Timeline you want to copy the transition to, so they’re highlighted green. Release the Command-Key.
  - Right-Click on any one of the green highlighted edit points, and select Paste (or hit Command-V) to duplicate the selected transition to all selected edit points.

Methods of altering transitions in the Timeline:

- To change a transition’s type: Drag a different transition from the Effects Library onto the current one in the Timeline.
- To change a transition’s duration: Drag the beginning or end of the transition in the Timeline to be longer or shorter symmetrically about the current edit. Alternately, you can do one of the following:
  - Right-click any transition and select Change Transition Duration, or select the transition and press Command-D, then alter the duration in the dialog that appears, and click Change.
  - Double-click any transition to open it in the Inspector, and set a new duration in seconds or frames.
- To change a transition’s alignment: Right-click a transition in the Timeline and choose a new method of alignment from the contextual menu. Alternately, you can double-click any transition to open it in the Inspector, and choose a new option from the Alignment drop-down.
- To remove a transition: Select a transition in the Timeline and press the Delete key. Or, right-click a transition in the Timeline and choose Delete from the contextual menu.

Adding Transitions When There’s Not Enough Handles

If the outgoing and incoming overlapping handles at a given edit point don’t have enough frames to fit the standard transition duration, and you try to add a transition by selecting one or more edit points and pressing Command-T, or by right-clicking an edit point and using the transition options in the resulting contextual menu, then you’ll be presented with a dialog that gives you three choices:
– **Trim Clips**: You can automatically trim the incoming and outgoing sides of each selected edit point to create the overlap needed for adding the standard transition.

– **Skip Clips**: Don’t add transitions to the selected edit points that lack the appropriate overlap.

– **Cancel**: Cancel the operation entirely.

# Adding Transitions By Dragging to Create Overlap

There’s another method you can use to create transitions that makes it easy to create transitions while you’re doing drag and drop editing by simply overlapping the beginning and end of two clips where you want a transition to appear. Just press and hold the Option and Shift keyboard modifiers together while you drag a clip or edit to create overlap with another clip. You can do this in three ways:

– Select the In or Out point of a clip, then press and hold Option-Shift down and drag the selected edit point to overlap a neighboring clip where you want to create a transition.

– Select a clip, then press and hold Option-Shift down and drag the entire clip to overlap a neighboring clip where you want to create a transition.

– Hold the Option-Shift keys down while you drag a clip from the Media Pool to overlap a clip that’s already in the Timeline.
Transition Properties in the Inspector

Double-clicking a transition in the Timeline opens that Transition tab in the Inspector. Each transition has the following properties you can edit.

- **Transition Type**: The currently selected transition. You can change to any other installed transition by selecting one in the drop-down menu.
- **Duration**: The duration of the transition, shown in both seconds and frames.
- **Alignment**: A drop-down that lets you choose the transition’s position relative to the edit point it’s applied to. Your choices are “Start on Edit,” “Center on Edit,” and “End on Edit.”

Additional properties that are specific to each type of transition appear in another group below. Since the Cross Dissolve transition is the most common transition used, its properties will be shown as an example.

- **Style**: The different Dissolve transitions (Cross Dissolve, Additive Dissolve, and so on) expose this drop-down that lets you choose different ways for the outgoing clip to blend into the incoming clip during the dissolve. There are six different options to choose from:
  - **Video**: A simple linear dissolve; the outgoing clip fades out as the incoming clip fades in.
  - **Film**: A logarithmic dissolve, simulating film dissolves as created by an optical printer.
  - **Additive**: The outgoing and incoming clips are cross faded using the Additive composite mode. As a result, the transition seems to brighten at the halfway point.
  - **Subtractive**: The outgoing and incoming clips are cross faded using the Subtractive composite mode. As a result, the transition seems to darken at the halfway point.
  - **Highlights**: The outgoing and incoming clips are cross faded using the Lighten composite mode. The lightest parts of each clip are emphasized during this transition.
  - **Shadows**: The outgoing and incoming clips are cross faded using the Darken composite mode. The darkest parts of each clip are emphasized during this transition.

- **Start Ratio**: Defines the percentage of completion for the transition at its first frame, from 0 to 100 percent. Setting the Start Ratio to anything but 0 results in the transition immediately appearing at a more fully cross-dissolved state from the very first frame.

- **End Ratio**: Defines the percentage of completion for the transition at its last frame. Setting the End Ratio to anything but 0 results in the transition never fully dissolving to the incoming shot at its last frame.

- **Reverse**: Reverses the transition. This parameter is disabled for Dissolve transitions.

- **Ease**: A drop-down that lets you apply nonlinear acceleration to the beginning, ending, or overall duration of a transition. The result is to add inertia to the transition from the outgoing clip to the incoming clip, and providing a gentler change from each clip into and out of the transition.
  - **None**: The outgoing clip fades away to the next shot in a linear fashion.
  - **In**: The outgoing clip lingers as the beginning of the transition dissolves more slowly than the end.
  - **Out**: The outgoing clip fades away more quickly, as the beginning of the transition dissolves more quickly than the end.
  - **In & Out**: Both the outgoing and incoming clips make slower transitions at the beginning and end of the dissolve, but the very center of the transition is faster as a result.
  - **Custom**: Lets you modify the parameters of the fade manually using the Transition Curves below.
– **Transition Curve**: Allows you to manually set keyframes controlling the progress of the transition along its duration.

Other types of transitions display properties that are specific to that transition's particular effect. These are described at length in the following section.

**Using Transition Curves in the Edit Page**

You can create even more highly customized transition effects using the transition curve associated with each transition you add to the Timeline. Clicking the button at the bottom-right corner of a transition in the Timeline reveals a Keyframe Editor, and clicking the Curve Editor button in the Keyframe Editor track for the transition reveals the Transition Curve Editor.

![A transition curve opened underneath a Cross Dissolve transition](image)

The Transition Curve Editor works identically to the Curve Editor you can access from any clip, except instead of using the curve to animate image transforms, you use the curve to retime the transition. Combined with eased or bezier keyframes at the beginning and end of a transition curve, you can create transitions that slowly start and quickly end, quickly start and slowly end, or any variation your project requires. A graphical representation of the curve appears as a shaded area on the transition itself in the Timeline.

**Methods of editing a transition curve:**

– **To change the interpolation of a control point**: Click the control point you want to edit, and then click one of the four Bezier interpolation buttons in the Curve Editor title bar. Adding Bezier handles to a transition control point lets you create an eased transition. If you chose an option from the Ease drop-down of the Transition Properties in the Inspector, one or both of the transition curve keyframes may already be set to Bezier.

– **To adjust a Bezier handle**: Drag the Bezier handle in any direction to alter the curve. Whenever you customize Bezier handles on a transition curve, the Ease drop-down of the Transition Properties in the Inspector changes to Custom.

– **To add a new control point to a curve**: Option-click anywhere on a curve to add a new control point.

– **To drag a control point on a curve**: Click any control point and drag left or right to retime it, and up or down to change the value of the control point. Once you begin to move the pointer, the control point is constrained in that direction.
– **To delete a control point from a curve:** Right-click a keyframe and choose Delete Selected from the contextual menu. You cannot delete the last two control points of a transition curve.

– **To turn a curve on and off:** Clicking the white dot at the upper left-hand corner of the Keyframe Editor lets you turn a transition curve’s effect on and off, without disabling the transition. When you turn the keyframes off, the transition defaults to a linear transition with no easing.

### Favorite Transitions

While DaVinci Resolve provides a wide variety of transitions by default, most editors typically only use a subset of these in their day-to-day work. Also, it’s typical to save customized versions of a particular transition in order to reuse that specific set of transition settings over and over again.

**To set a transition or other effect as a favorite in the Effects Library:**

– Move the pointer over any transition, and click the star button when it appears to set that transition as a favorite. Click any transition’s star to “un-favorite” it. Favorites are displayed in the Favorites area of the Effects Library bin list in the Edit page, or the Favorites tab in the Transitions panel in the Cut page.

### Changing the Standard Transition

Different projects may require different transitions be used as the standard transition. DaVinci Resolve gives you several tools for dealing with this.

**To change the standard transition:**

– Right-click any transition or effect and choose “Set as Standard Transition.” The standard transition appears with an orange indicator to the left of its name in the Effects Library.
The Transitions tab open in the Cut page, showing starred transitions that have been favorited, and the standard transition with an orange indicator to the left of its name

**To change the standard transition duration:**

– Open the Editing panel of the User Preferences, and change the “Standard transition duration” setting (there are controls for setting the duration in either Seconds or Frames). Click Save when you’re finished.

**Creating Transition Presets**

If you find yourself using a particular transition that’s customized in a particular way over and over in your work, you can create a Preset of that transition for easy recall. Once saved, Presets can be favorited or set to be the Standard Transition to make them more easily available.

**To save a transition preset for future use:**

1. Add a transition to the Timeline, then double-click it to open it in the Inspector to adjust its settings to be the way you need it to be.
2. (Optional) if necessary, open the transition’s Curve Editor and set the type of curve you want the transition to have. A customized transition curve will be saved inside of that transition’s preset.
3. Right-click on the transition you want to save, and choose Create Transition Preset.
4. Type a name for the transition preset in the dialog that appears, and click OK. That transition is saved to the User section at the bottom of the Toolbox Video Transitions area, where you can apply it just like any other transition.

**To remove a transition preset:**

– Right-click any preset and choose Delete Transition Preset.

**Changing Transitions to Fusion Compositions**

If you need to create a more complex transition than you can get from the Inspector, it is now possible to change any transition to a Fusion Composition on the Edit page Timeline.

**To convert a Resolve transition to a Fusion composition:**

1. Add a transition between two clips on your Timeline.
2. Right-click on the transition and select “Convert to Fusion Cross Dissolve.”
3. Right-click on the transition again and select “Open in Fusion Page.”
A new Fusion composition opens with the base Cross Dissolve nodes and tools already set. You now can use all of the powerful tools in the Fusion page to customize your transition.

The node tree you start with after converting a transition to a Fusion cross dissolve

**Video Transitions**

The following are transitions that are available within DaVinci Resolve by default, along with the parameters that are available for each of them from the Inspector:

**Dissolve**

A dissolve in the visual language of film generally denotes a passage of time or place. It indicates to your audience that one scene has ended and another is beginning.

- **Additive Dissolve:** Style lets you choose what type of cross dissolve you want; choices include: Video, Film, Additive, Subtractive, Highlights, Shadows. Start Ratio lets you adjust how far along the transition is when it first begins. End Ratio lets you adjust how far the transition gets at the very end. The Reverse checkbox reverses the direction of the transition.

- **Blur Dissolve:** Horizontal/Vertical Strength sets how much blur is performed in the X and Y dimensions during the course of this transition. Start Ratio lets you adjust how far along the transition is when it first begins. End Ratio lets you adjust how far the transition gets at the very end. The Reverse checkbox reverses the direction of the transition.

- **Cross Dissolve:** Style lets you choose what type of cross dissolve you want; choices include: Video, Film, Additive, Subtractive, Highlights, Shadows. Start Ratio lets you adjust how far along the transition is when it first begins. End Ratio lets you adjust how far the transition gets at the very end. The Reverse checkbox reverses the direction of the transition.

- **Dip to Color Dissolve:** Start Ratio lets you adjust how far along the transition is when it first begins. End Ratio lets you adjust how far the transition gets at the very end. The Reverse checkbox reverses the direction of the transition. Color lets you choose what color the dissolve dips to at the midpoint.

- **Non-Additive Dissolve:** Start Ratio lets you adjust how far along the transition is when it first begins. End Ratio lets you adjust how far the transition gets at the very end. The Reverse checkbox reverses the direction of the transition.

- **Smooth Cut:** A special-purpose transition designed to make short jump cuts in the middle of a clip less noticeable. This is done by using optical flow processing to match the same features on either side of a cut in order to automatically morph a subject from one position to another over the duration of the transition.

  A Mode drop-down menu provides two options: Faster and Better. The Better option is default, with excellent quality and the capability of preserving the motion of subjects for the duration of the transition. The Faster option is the original Smooth Cut method, which morphs between stills of the outgoing and incoming frames. In most practical circumstances, the Better mode will give you a superior result, but certain cuts or effects may be better addressed with the Faster option.
The Smooth Cut effect works best on clips such as sit-down interviews and close-up head shots with a minimum of background and subject motion, and where the subject’s position on either side of the cut is not significantly different. A good example of when Smooth Cut is effective is when you’re cutting pauses, partial repeats, filler sounds such as “um” or “you know,” or other speech disfluencies out of an interview clip to tighten the dialog, and you want to eliminate the little “jump” that occurs at the cut without having to cut away to B-roll. Applying a short two or four frame Smooth Cut transition to the edit can make this kind of edit invisible, as long as the speaker doesn’t change position significantly during the cut. The more motion there is in the background of the shot, and the more the speaker changes position, the harder it will be to get a useful result using Smooth Cut. Although the default duration for any transition is one second, you’ll find that Smooth Cut transitions work much better when they’re short; 2- to 6-frame Smooth Cut transitions often work best to disguise jump cuts.

**Iris**

Iris are directional transitions that are commonly used to both call attention to a specific part of the frame and indicate to the audience that one scene has ended and another begun. Irises were widely used in the silent film era instead of the more technically complicated dissolve.

- **Arrow Iris:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Offset to center lets you alter the center point at which this transition is positioned. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition. Box mode lets you choose one of the following presets:
  - Arrow Head Up
  - Arrow Head Bottom
  - Arrow Head Left
  - Arrow Head Right

- **Cross Iris:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Offset to Center identifies the center point at which the cross wipe begins, as X and Y coordinates on the screen. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition.

- **Diamond Iris:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Offset to Center identifies the center point at which the diamond-shaped wipe begins, as X and Y coordinates on the screen. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition.

- **Eye Iris:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition.

- **Hexagon Iris:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Offset to center lets you alter the center point at which this transition is positioned. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition. Box mode lets you choose one of the following presets:
  - Hexagon
  - Hexagon Rotate
– **Oval Iris:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Offset to Center identifies the center point at which this circular wipe begins, as X and Y coordinates on the screen. Oval Ratio changes the aspect ratio of the oval, making it either wider or taller. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition.

– **Pentagon Iris:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Offset to center lets you alter the center point at which this transition is positioned. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition. Box mode lets you choose one of the following presets:
  – Pentagon Up
  – Pentagon Down

– **Triangle Iris:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Offset to center lets you alter the center point at which this transition is positioned. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition. Box mode lets you choose one of the following presets:
  – Triangle Up
  – Triangle Bottom
  – Triangle Left
  – Triangle Right

**Motion**

Motion transitions use the movement of the frames to impart simulated physical momentum to the transition between the outgoing and incoming clips.

– **Barn Door:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition. Motion Blur smooths out the motion of the transition between frames. Preset mode lets you choose one of the following presets:
  – Barn Door Vertical
  – Barn Door Horizontal

– **Push:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition. Motion Blur smooths out the motion of the transition between frames. Preset mode lets you choose one of the following presets:
  – Push Left
  – Push Right
  – Push Up
  – Push Down

– **Slide:** Direction determines whether or not the incoming clip slides in or the outgoing clip slides out. Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition. Motion Blur smooths out the motion of the transition between frames. Preset mode lets you choose one of the following presets:
– Slide, Left-Right
– Slide, Right-Left
– Slide, Bottom-Up
– Slide, Top-Down
– Slide, Top-Left
– Slide, Bottom-Right

– **Split:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition. Motion Blur smooths out the motion of the transition between frames.

**Shape**

Shape transitions use geometrical outlines to define the transition from the outgoing to the incoming clip. Ideally the shape used will be motivated by the content of the scenes involved.

– **Box:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition. Box mode lets you choose one of the following options:
  – Upper Left
  – Upper Right
  – Lower Left
  – Lower Right
  – Left Center
  – Top Center
  – Right Center
  – Bottom Center

– **Heart:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Offset to Center identifies the center point at which this circular wipe begins, as X and Y coordinates on the screen. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition.

– **Star:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Offset to Center identifies the center point at which this circular wipe begins, as X and Y coordinates on the screen. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition.

– **Triangle Left:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition.

– **Triangle Right:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition.
**Wipe**

Wipe transitions are intended to preserve the continuity of motion between two clips. They do this by matching the overall movement and direction of the subjects across the outgoing and incoming clips.

- **Band Wipe:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition. Preset lets you choose one of the following presets:
  - Horizontal
  - Vertical
  - Horizontal Bilinear
  - Vertical Bilinear

- **Center Wipe:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Angle specifies the angle of the wipe as it emerges from the middle of the screen. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition.

- **Clock Wipe:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Angle specifies the starting angle of the wipe as it spins around the center of the screen. The Clockwise checkbox sets the direction of the clock wipe. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition.

- **Edge Wipe:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Angle specifies the angle of the wipe as it moves across the screen. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition.

- **Radial Wipe:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition.

- **Spiral Wipe:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition.

- **Venetian Blind Wipe:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Repeat specifies how many “blinds” appear within the wipe effect. Angle specifies the angle of this multi-wipe effect. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition.

- **X Wipe:** Color sets the color of the border, if there is one. Border sets the width of the border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the Border slider to determine the amount of feathering at the edge of the transition.

**User Transitions**

Any transition presets you’ve created are stored in the User category. These are the only transitions that can be deleted.
**Fusion Transitions**

The Fusion Transitions section of the Transitions panel contains Fusion effects that have been made into reusable transitions. Fusion Transitions work like any other transition. Once edited into the Timeline, they can be edited like any other transition, and when selected, they expose customizable parameters in the Inspector that let you tailor their effect to meet your needs.

However, Fusion Transitions are highly customizable. Simply right-click a Fusion Transition and choose Open in Fusion Page to expose all of the Fusion nodes that create that transition’s effect, enabling you to rebuild it to do whatever you need. When you go back to the Edit page, that transition is automatically saved.

Furthermore, if you know how to create effects in Fusion, you can create your own Transitions by making Fusion Macros and saving them to the Effects Library, so they appear in the Fusion Transitions section of the Effects Library. For more information on how to do this, see Chapter 67, “Node Groups, Macros, and Fusion Templates.”

---

**Resolve FX Transitions**

Resolve FX Transitions are stylized graphical transitions that are more computationally intensive than the standard wipes and dissolves.

**Burn Away Transition**

This transition replicates the visual of a film print burning up in the projector. Use this transition to achieve a classically retro effect, or to strike terror into the hearts of projectionists everywhere.

![Burn Away transition showing two pirates concerned about the state of their release print](image)

The Burn Away effect has the following parameters:

**Progression**

This set of controls affects the type of movement the burn takes as it passes through the frame.

- **Motion**: Allows you to pick a type of burning effect. Each option reveals different parameters.
- **Directional**: The burn moves linearly from one edge of the frame to another. This setting replicates the film being torn away by the take-up reel as it burns. In this mode, the OFX overlay in the Viewer lets you choose the direction.
- **Hotspots**: The burn erupts from one or more central points. This setting replicates the film jamming in front of a projector bulb and melting away. In this mode, the OFX overlay in the Viewer lets you move the burn points directly in the Viewer.
- **Path**: Creates a curved path that the burn follows. This setting allows you to specify the burn direction precisely, to account for elements in the frame that you want to burn first. In this mode, the OFX overlay in the Viewer lets you add points to a spline with which to create any curved motion path you want the effect to use.

- **Angle**: (Directional Only) The angle that the burn moves along. You can also change this in the Viewer directly in Open FX Overlay mode.

- **Number of Hotspots**: (Hotspots Only) The number of points that the burn erupts from. The possible values are from 1 to 8.

- **Randomize Hotspots**: (Hotspots Only) Will pick a random distribution of the hotspots in the frame.

- **Number of Points**: (Path Only) The number of points on the onscreen curve control. The range is from 2 to 5. These points can be manipulated directly in the Viewer in Open FX Overlay mode.

**Adjust Timing**

This set of parameters allows you to control the start and end progression of the burn.

- **Adjust Start**: Adjusts how far along in the transition the effect starts. Values are from -1.000 to 1.000.

- **Adjust End**: Adjusts how far along in the transition the effect ends. Values are from 0.000 to 2.000.

**Edge**

These controls let you adjust the qualities of the edge of the film as it burns.

- **Raggedness**: How rough the edge of the burn is. Values are from 0.000 (perfectly flat) to 1.000 (extremely rough).

- **Scale**: The scale of the raggedness. Values are from 1.00 to 10.00.

**Appearance**

These controls adjust the look and color of the burn as it moves through the transition.

- **Melt**: Controls the amount of distortion in the image as it burns away. Values are from 0.000 to 1.000.

- **Char**: Controls the amount of darkened charring along the edge. Values are from 0.000 to 1.000.

- **Char Color**: Lets you select the color of the Char effect.

- **Burn**: Lets you set the thickness of the burn effect. Values are from 0.000 (no burn) to 1.000 (maximum thickness).

- **Burn Hue**: Lets you select the hue of the Burn effect.

- **Burn Sat**: Lets you select the intensity of the color of the Burn effect.

- **Burn Brightness**: Lets you set the brightness of the Burn effect. At lower values, the burning edge assumes a motley, irregular effect. Values are from 0.000 to 1.000.

- **Glow Brightness**: Lets you control the intensity of a glow effect emanating from the Burn effect. Values are from 0.000 to 2.000.

- **Glow Spread**: Lets you control the width of the glow effect. Values are from 0.000 to 2.000.

- **Ash**: Controls how much ash trails behind the burn as it moves through the frame. Values are from 0.000 to 1.000.

- **Ash Color**: The color of the Ash parameter.
DCTL Transition

DCTL (DaVinci Color Transform Language)-based transitions are now supported in DaVinci Resolve. See the DaVinci Resolve Developer Documentation in the help menu for more details.

Audio Transitions

A single audio transition handles all of your crossfade needs.

- **Cross Fade +3/-3/0 dB**: An audio-only transition that lets you fade from one audio clip to another. Three different crossfades let you choose the power of the actual transition from one level to the other.

OpenFX Transitions

If you’ve installed one or more sets of OpenFX plug-ins on your DaVinci Resolve workstation, any transitions within those sets will appear in the OpenFX panel of the Effects Library.
Chapter 50

Titles, Generators, and Stills

Using the Edit page, you can add titles, effects generators, and stills to your timelines. You can also save customized titles, generators, and stills back to the Media Pool for future use.

Contents

Adding Titles 852
Using Safe Area Overlays 853
Custom Action and Title Safe Areas 853
Types of Title Generators 853
DaVinci Resolve Title Generators 854
Editing Titles Within the Timeline Viewer 854
Title Generator Panels 855
Shared Title Generator Parameters 855
Title Generator Settings Parameters 857
The Text+ Title Generator 857
Fusion Titles and Fusion Templates 859
Saving Titles in the Media Pool for Future Use 860
Using Generators 860
ITU-R BT.2111-1 Color Bar Generators 861
Fusion Generators 862
Using Stills 862
Photoshop File Support 863
Adding Titles

There’s a collection of titles and generators in the Toolbox that you can use to create leader when outputting to tape, add slates, create subtitles, and otherwise fulfill any textual needs your program has.

To select and audition titles before you place them into the Timeline, ensure that “Hover Scrub Preview” is checked in the Titles option menu, then simply hover your pointer over any thumbnail in the Titles tab. If the title is animated (i.e., Fusion titles), moving the pointer across the thumbnail will preview the animation. Once you’ve chosen your title, you can drag it from the Titles tab to your Timeline in the Edit page or in the Cut page to either the upper or lower Timelines, or use the editing selection modes at the bottom of the tab.

Scrubbing over a Title Thumbnail previews the title in the Viewer.

Titles and generators can be edited much like any other clip. Furthermore, when selected, both titles and generators expose the same Composite, Transform, and Cropping parameter groups as any other clip; these parameters can be used to composite titles and fly them around in order to create different text effects.

Methods of adding and editing generators and titles:

- **To drag and drop a generator directly into the Timeline:** If you simply drag and drop titles or generators into the Timeline, the default duration of the resulting clip is 5 seconds. This duration can be customized in the Edit panel of the User Preferences.

- **To edit a generator using the edit overlays of the Timeline Viewer:** Click the destination control of the clip you want to edit a generator into, then set Timeline In and Out points to define the duration of the resulting edit, and drag the generator you want to edit onto the edit overlay of the Timeline Viewer that corresponds to the type of edit you want to perform.

- **To reposition the text of a title in the Timeline Viewer:** Select the title generator you want to edit in the Timeline, then click the visible text in the Timeline Viewer so that its bounding box is selected; in this state you can reposition, scale, and rotate the text item. As you reposition text, it will snap to key regions of the frame such as the vertical and horizontal center of the Viewer; hold the Option key down to suspend snapping if you want to freely position the text.

- **To edit the text of a title in the Timeline Viewer:** Select the title generator you want to edit in the Timeline, then double-click the visible text in the Timeline Viewer to insert a text editing cursor. At this point, you can select, delete, or add any text you want by typing directly in the Timeline Viewer.

- **To edit the parameters of a generator or title:** Open the Inspector, and select the generator or title you want to edit to open it into the Inspector.
Using Safe Area Overlays

If you’re working on a broadcast program and you want to adhere to guidelines for title safe and broadcast safe, you can choose to display overlays that indicate where these regions are in the Edit page.

To do so, choose View > Safe Area > On.

The available safe area overlays

If necessary, there are a number of ways you can customize this overlay by choosing one of the other options in the View > Safe Area submenu to toggle specific parts of the safe area overlay on and off. These options include:

- **Extents**: An outline showing the exact outer edge of the frame. Especially useful when the safe markers are set to an aspect ratio other than that currently used by the Viewer.
- **Action**: An outline showing the outer 90% action safe area of the frame.
- **Title**: An outline showing the outer 80% title safe area of the frame.
- **Center**: A crosshairs showing the center of the frame.
- **Aspect**: Enables use of the View > Select Aspect Ratio submenu to change the aspect ratio of the safe area markers. You can choose among the following aspect ratios: 1.33 (a.k.a. 4:3), 1.66, 1.77 (a.k.a. 16:9), 1.85, and 2.35.

Custom Action and Title Safe Areas

The Editing panel of the User Preferences has a new “Use custom safe area overlays” checkbox that, when turned on, displays Action Area and Title Area fields that let you set a custom percentage for each. The default values are 93% for Action Area and 90% for Title Area.

Types of Title Generators

When opened into the Inspector, titles expose a set of text parameters that allow you to style the contents of that clip’s Text field within the Inspector. Each of the titles supports rich text, so you can individually style words, lines, or paragraphs of text using the available parameters including Color, Font, and Size. Other attributes such as Alignment, Anchor, Position, and Shadow affect the entire title.
The following titles are available:

- **L Lower 3rd**: (supports rich text) Automatically positions two lines of text at the bottom left corner of title safe, each with a different set of rich text and Position/Zoom/Rotation controls for independent sizing and animating.

- **M Lower 3rd**: (supports rich text) Automatically positions two lines of text at the bottom middle of title safe, each with a different set of rich text and Position/Zoom/Rotation controls for independent sizing and animating.

- **R Lower 3rd**: (supports rich text) Automatically positions two lines of text at the bottom right corner of title safe, each with a different set of rich text and Position/Zoom/Rotation controls for independent sizing and animating.

- **Scroll**: (supports rich text) Automatically automates a scrolling title sequence from the bottom to the top of the screen. The duration of the generator clip in the Timeline determines the speed of the scroll. Identical parameters as the Simple title.

- **Text**: (supports rich text) Useful for creating titles consisting of a word, line, or paragraph of text. A single body of text shares one set of rich text controls that let you style selected parts of the title text differently.

- **Text+**: (does not support rich text) An advanced title generator based on the title generation tools on the Fusion page. This generator has significantly more options for styling, rendering, and animating than the simple title generator above, but all title text shares a single style.

- **Fusion Titles**: A variety of pre-built title templates assembled in Fusion. DaVinci Resolve comes with a library of pre-assembled Fusion titles, but you can also create your own to appear in this category of the Effects browser.

## DaVinci Resolve Title Generators

The original title generators that shipped with DaVinci Resolve all share similar controls, and they all share the ability to support rich text styling.

### Editing Titles Within the Timeline Viewer

Once you add a title generator to the Timeline, the original title generators that shipped with DaVinci Resolve have onscreen controls that let you edit text and transform and position blocks of text directly within the Timeline Viewer.

### Positioning and Transforming Text

So long as the Timeline playhead is positioned over a text generator that’s on top of one or more background clips, clicking on the text in the Timeline Viewer reveals onscreen transform controls that correspond to the Position, Zoom, and Rotation parameters in the Inspector.

Drag the text to position it in the Viewer
While dragging text to reposition it, snapping occurs at the X and Y center of the frame, as well as around the outer third of the frame. Holding the Shift key down while dragging a text object constrains movement to just the X or Y axes.

Editing Text
Double-clicking on text in the Timeline Viewer puts that text into an editable state, wherein you can insert a text cursor or select characters to edit the text as you would in any text editor.

Double-click on the text to edit it in the Viewer

Title Generator Panels
The parameters of text generators are divided into two panels in the Video Inspector: the Title panel and the Settings panel.

- The Title panel contains all of the text editing, styling, and sizing controls used to edit the contents and look of a title in your project, including the Rich Text, Drop Shadow, Stroke, and Background parameters.
- The Settings panel contains the same Composite, Transform, and Cropping parameters that all other clips in DaVinci Resolve have. These parameters are intended for compositing and animating a title.

Shared Title Generator Parameters
With the exception of the Text+ generator, all other title generators in DaVinci Resolve are capable of rich text styling. This means you can select any portion of a generator's text and style it differently. For example, you could have three lines of text within a single generator and style each line individually to create a particular design.

A single generator with three lines of differently styled text
Each title generator shares the same parameters in the Video Title panel of the Inspector for editing and styling text:

- **Rich Text**: A control group consisting of a text entry field and parameters that can be used to style different parts of the text independently.
- **Text**: A text entry field for editing the title being generated. If no characters are selected, the styling controls affect the entire block of text. If you select a specific set of characters, the styling controls only affect the selection. Text in this field can also be edited directly in the Timeline Viewer.
- **Font family**: A pop-up for choosing one of the font families installed on your workstation.
- **Font face**: A pop-up for choosing which face of the font family currently selected to use.
- **Color**: Opens the standard color picker for choosing a font color.
- **Size**: Slider for choosing the text size.
- **Tracking**: Slider that sets the spacing between characters.
- **Line spacing**: Slider for setting the spacing between the selected line of text and the next one below.
- **Font style**: Buttons to apply underline, overhead line, strikethrough, superscript, and subscript styling.
- **Font case**: A pop-up for forcing the text selection to be Mixed Case (the default), All Caps, All Lowercase, Small Caps, or Title Caps.
- **Alignment**: Buttons to select the method of alignment: left, centered, right, or justified.
- **Anchor**: Buttons for selecting how text is anchored to the current position, both horizontally (top, centered, bottom) and vertically (right, centered, left).
- **Position**: X and Y parameters determining the bottom left-hand corner (the default Anchor settings) of the rich text block being generated. Corresponds to the act of dragging a selected text box in the Timeline Viewer.
- **Zoom**: X and Y parameters determining the scale of the text. A link button lets you keep the X and Y parameters locked together. Corresponds to the act of resizing a selected text box in the Timeline Viewer from either the corners (to resize proportionally), or the top/bottom/sides (to stretch or squeeze the text).
- **Rotation Angle**: A slider for rotating the orientation of the text. Corresponds to the act of rotating a selected text box in the Timeline Viewer using the rotation handle.

- **Drop Shadow**: A group of controls that lets you apply a customizable drop shadow to every character of text being generated.
  - **Color**: Opens the standard color picker for choosing a drop shadow color.
  - **Offset**: X and Y parameters determining how offset the drop shadow is from the original text.
  - **Blur**: A slider for blurring the drop shadow.
  - **Opacity**: A slider determining how transparent the drop shadow is.

- **Stroke**: Lets you add an outline to every character of text being generated.
  - **Color**: Opens the standard color picker for choosing the stroke color.
  - **Size**: A slider lets you choose the thickness of the stroke, in pixels.
– **Background:** This group of controls provides an extremely flexible rectangle or rounded rectangle shape that you can use to add a background, bar, outline, or other intersecting shape to use when designing a title.

– **Color:** Opens the standard color picker for choosing the interior color of the background shape.

– **Outline color:** Opens the standard color picker for choosing outline color of the background shape.

– **Outline width:** A slider lets you choose the thickness of the background shape outline, in pixels.

– **Width:** A slider lets you choose how wide to make the background shape.

– **Height:** A slider lets you choose how tall to make the background shape.

– **Corner radius:** A slider lets you choose the roundness of the rectangle edges.

– **Center:** X and Y parameters you can use to offset the background shape from the text being generated.

– **Opacity:** A slider lets you set the transparency of the background shape.

### Title Generator Settings Parameters

Additionally, each generator has Composite, Transform, and Cropping parameters in the Settings panel of the Video Inspector that let you composite, resize, and animate titles against other clips in the Timeline for motion graphics effects. These parameters are the same as those available for every clip, as described later in this chapter.

### The Text+ Title Generator

A new kind of title generator, named Text+, is available in the Titles category of the Effects Library’s toolbox. This is the exceptionally fully-featured 2D text generator from Fusion, available for editing and customizing right in the Edit page. It’s capable of most of what the Text generator can do, with the exception of rich text editing and a lack of on-screen controls in the Timeline Viewer. However, it also has many more styling and animation controls than the Text generator has.

**TIP:** At the time of this writing, the Text generator is still very useful for quickly creating text pages with multiple styles, whereas the Text+ generator excels at creating text for animated motion graphics.
You can use the Text+ generator the same way you use any generator in the Edit page. Simply edit it into a video track of the Timeline, select it, and open the Inspector to edit and keyframe its numerous properties to create whatever kind of title you need.

In addition to having many more styling options, the origin of the Text+ generator in a compositing tool means that it offers many more panels worth of keyframable parameters, along with advanced animation controls built-in. These include keyframable Write On/Write Off controls, layout and animation using shapes (options include point, frame, circle, and path), character, word, and line transforms and animation, advanced shading, and full interlacing support.
Better yet, with the playhead parked on your new Text+ "Fusion Title," you can open the Fusion page and access its parameters there too, if you want to start building upon this single generator to create a multi-layered motion graphics extravaganza.

Opening the Text+ node in the Fusion page reveals it as an actual Fusion page operation.

For more information about the extensive capabilities of the Text+ generator, see Chapter 104, “Generator Nodes.”

**Fusion Titles and Fusion Templates**

The abundance of other Fusion titles in the Effects Library are custom-built text compositions with built-in animation that expose custom controls in the Inspector.

In actuality, these text generators are Fusion templates, which are Fusion compositions that have been turned into macros and come installed with DaVinci Resolve to be used from within the Edit page like any other generator.

It’s possible to make all kinds of Fusion title compositions in the Fusion page, and save them for use in the Edit page by creating a macro and placing it within the /Library/Application Support/ Blackmagic Design/DaVinci Resolve/Fusion/Templates/Edit/Titles directory, but this is a topic for another day.

There’s one other benefit to Text+ generators and that is they can be graded like any other clip, without needing to create a compound clip first.
Saving Titles in the Media Pool for Future Use

If you’ve created a title in a style that you want to later reuse, for example, a particularly formatted lower third that will be the basis for every lower-third in your program, you can drag any title from the Timeline to the Media Pool, and it will be saved as a separate clip. Title clips in the Media Pool are shown with a thumbnail showing a preview of the text they contain. If you’ve keyframed any animated text or video adjustments, those keyframes are also saved with this clip.

Once saved in the Media Pool, text generators can be opened in the Source Viewer and edited just like any other clip.

Using Generators

Generators, with the exception of Solid Color, lack editable parameters other than the Composite, Transform, Cropping, and Dynamic Zoom parameters that are standard for every clip. Additionally, generators have a Display Name field in the Inspector that lets you give a particular clip a custom name that appears in the Timeline.

The various video generators included in DaVinci Resolve can be previewed by hovering your pointer over any thumbnail in the Generators tab. To edit a generator into your timeline, simply grab the thumbnail of the generator you wish to use, and place it in your Timeline in the Edit page, or in either the upper or lower Timelines in the Cut page.

The following generators are available:

- **10 Step**: A grayscale ramp segmented into 10 steps from black to white.
- **100mV Steps**: A grayscale ramp segmented into segments of exactly 100mV each.
- **BT.2111 Color Bar HLG Narrow**: Use these bars if your HDR timeline is using a Hybrid Log Gamma curve (HLG). This is most commonly used in broadcast for its simple backward compatibility with SDR televisions.
- **BT.2111 Color Bar PQ Full**: While PQ Full is a part of the Rec. 2100 (BT.2100) specification, it is not commonly in use at this time. Use this setting only if you know you need it.
- **BT.2111 Color Bar PQ Narrow**: Use these bars if your HDR timeline is using a format with a PQ gamma curve (i.e., DolbyVision or HDR10). This is most commonly used for video streaming services and Blu-ray discs.
- **EBU Color Bar**: A 1.77:1 aspect ratio set of color bars for PAL-using countries.
- **Four Color Gradient**: A gradient that blends four different colors at each corner of the frame. You can adjust the Center X and Center Y parameters to move the center at which all four colors blend together, and you can change the four colors that appear at each corner using corresponding color parameters.

- **Grey Scale**: A simple grayscale ramp from black to white.

- **SMPTE Color Bar**: An updated 1.77:1 aspect ratio set of color bars for NTSC-using countries.

- **Solid Color**: A simple fullscreen color generator. A Color parameter lets you choose what color this generator outputs.

- **Window**: A simple white-on-black shape generator, defaulting to a white rectangle against a black background.

- **YCbCr Ramp**: A gradient designed to test the Y’CbCr signal.

### ITU-R BT.2111-1 Color Bar Generators

DaVinci Resolve now includes a ITU-R BT.2111-1 specification Color Bar Generator for HDR video. These are the color bars to use when calibrating, analyzing, or mastering a Rec. 2100 (BT.2100) HDR signal.

These new color bars have saturation levels set at 100% at the top, and 75% in the middle section. They also contain Rec. 709 (BT.709) color bars in the lower corners for compatibility with HD SDR signals. Commonly referenced levels are indicated on the image below. The full color bar specification can be found on the ITU’s web site: [https://www.itu.int/rec/R-REC-BT.2111/en](https://www.itu.int/rec/R-REC-BT.2111/en).
Fusion Generators

The Fusion Generators section of the Generators panel contains Fusion effects that have been made into reusable generators. By default, a single generator, Noise Gradient, appears as an example of how these work. Fusion Generators work like any other generator. Once edited into the Timeline, they act like any other clip, and when selected, they expose customizable parameters in the Inspector that let you tailor their effect to meet your needs.

However, Fusion Generators are highly customizable. Simply opening the Fusion page while the playhead intersects a Fusion Generator on the topmost track of the Timeline exposes all of the Fusion nodes that create that generator’s effect, enabling you to rebuild the effect to do whatever you need. Furthermore, if you know how to create effects in Fusion, you can create your own generators by making Fusion Macros and saving them to the Effects Library, so they appear in the Fusion Generators section of the Effects Library. For more information on how to do this, see Chapter 67, "Node Groups, Macros, and Fusion Templates."

Using Stills

You can import still images into the Media Pool, and edit them into the Timeline as clips with custom durations. By default, imported stills are 10 seconds long, but you can extend a still image’s Out point to a maximum of 17 hours and 40 minutes in length, which ought to cover just about any project you’re planning on working on, so long as you’re not Andy Warhol. DaVinci Resolve is correspondingly capable of importing still image clips referenced by XML or AAF project files, so long as they’re in a supported format.
DaVinci Resolve supports the use of stills in the following formats:

<table>
<thead>
<tr>
<th>File Format</th>
<th>Alpha Channel Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>.tif</td>
<td>Yes</td>
</tr>
<tr>
<td>.png</td>
<td>Yes</td>
</tr>
<tr>
<td>.jpg</td>
<td>No</td>
</tr>
<tr>
<td>.dpx</td>
<td>No</td>
</tr>
<tr>
<td>.exr</td>
<td>Yes</td>
</tr>
<tr>
<td>.dng</td>
<td>No</td>
</tr>
<tr>
<td>.psd</td>
<td>No</td>
</tr>
<tr>
<td>.tga</td>
<td>Yes</td>
</tr>
<tr>
<td>.heif</td>
<td>No</td>
</tr>
<tr>
<td>.NEF</td>
<td>No</td>
</tr>
<tr>
<td>.CR2</td>
<td>No</td>
</tr>
</tbody>
</table>

Once edited into the Timeline, still image clips have the same Composite, Transform, Cropping, Retime, and Scaling attributes as any other clip.

**Photoshop File Support**

Photoshop (.psd) files appear as a single clip displaying only the bitmapped layers within the Edit page and Color page of DaVinci Resolve. Photoshop text layers and layer effects are not supported at the time of this writing.

**Fusion Page PSD Support**

The Fusion page has support for multi-layered Photoshop files. You can use the Fusion > Import > .PSD command to import Photoshop files such that each individual layer appears as a separate MediaIn node connected to a cascading series of Merge nodes, ready for you to work on.
Chapter 51

Compositing and Transforms in the Timeline

The Edit page is also home to many of the compositing and transform effects found in DaVinci Resolve. Many of these kinds of effects can be imported into DaVinci Resolve, including composite modes, opacity settings, and clips using alpha channels. Once in DaVinci Resolve, you can make changes to these effects in the Edit page. Alternately, you can also use DaVinci Resolve’s controls to create effects from scratch.

Contents

Composite Modes and Transparency Effects 865
More About Composite Modes 866
Opacity 869
Video Fader Handles 869
Fade In and Out to Playhead Commands 870
Alpha Channel Support 870
Keying in the Timeline Using Resolve FX 870
Setting Up a Green Screen (Chroma Key) on the Timeline 870
Using Resolve FX and Open FX Alpha for Track Compositing 871
Transform and Cropping in the Video Inspector 872
Transform 872
Smart Reframe (Studio Only) 873
Cropping 873
Dynamic Zoom 873
Composite Modes and Transparency Effects

Composite modes are effects that use various mathematical operations to combine one superimposed clip with another, relying on standard image processing math for each color channel whereby black pixels have a value of 0, white pixels have a value of 1, and descending levels of gray are represented by decimal point values (for instance, 0.5 represents 50% gray). When using composite modes to blend two clips together on the Timeline, the three color channels of each pair of pixels are combined using that particular composite mode’s math. The results can create transparency effects, increase image exposure, and combine multiple images in many creative and useful ways.

When using composite modes, it’s easy to push parts of the resulting image above the maximum or below the minimum values for brightness. However, this image data is not clipped, even through such areas of the picture may appear flat white or black. Out-of-range data as a result of a composite mode effect is preserved, and may be retrieved by later image processing operations in the Color page.

When you import XML project files, DaVinci Resolve imports whatever composite modes were used by clips in the original sequence. If necessary, you can then change a clip’s composite mode to one that will work better with whatever grade you’re creating. Of course, you can also add composite modes to clips that didn’t originally have them, adding new effects of your own.
All composite modes interact with the Opacity slider (found below the Composite Mode pop-up menu in the Inspector) to make a clip more or less transparent in addition to compositing already being done.

Composite modes can be used on clips that are superimposed over other clips in the Timeline. However, these composite modes are also available for use within a grade on the Color page using the Layer Mixer node, within which you can combine differently graded versions of an image in creative ways. For example, the Add and Overlay composite modes can be useful for creating glow effects, while Subtract and Difference can create more surreal effects.

Working with composite modes in the Edit page is simple.

**To set or change a composite mode for any clip:**
– Select a clip in the Timeline, then open the Video Inspector and choose one of the options from the Composite Mode pop-up menu.

![Composite mode and Opacity controls in the Timeline](image)

**To turn a clip's composite mode off:**
– Select a clip in the Timeline, then open the Inspector and choose Normal from the Composite Mode pop-up menu.

### More About Composite Modes

There are ten composite modes to choose from. For clarity, simple image math is used to help explain the available Composite Mode effects.

**Normal**
No image compositing is done. The topmost image on the Timeline or the bottom input of the Layer Mixer node occupies the entire frame.

**Add**
Each pair of pixels in both superimposed layers is added together. Layer order does not matter. This can result in a dramatic brightening of light areas of both images with areas of the picture that are blown out to maximum white, and this effect is often used by adding the brighter part of an image to itself to create hot glow effects. Image data going above 1.0 is preserved and may be retrieved by later color correction operations. On the other hand, black areas of either image do not alter the combined image at all (0 + n = n).

**Color**
Recombines two layers using HSL image components by combining the Luma of the bottom layer with the Hue and Saturation of the top layer.

**Color Burn**
Inverts the bottom layer, which is divided by the top layer, and the end result is itself inverted.

**Color Dodge**
The bottom layer pixels are divided by the top layer, which has been inverted.
Darken
Each pair of pixels in each color channel is compared, and the darker of the two is the output. Layer order does not matter. Darken is useful when you want the darker features of both layers to take precedence, but the output for any given pixel may be a color that doesn’t actually exist for that pixel in either of the source layers.

Darker Color
For each pair of pixels, all three color channels from the bottom layer are added together, and all three color channels from the top layer are added together. These results are compared, and the darker pixel of the two layers is the output. Layer order does not matter. Darker Color is useful when you want the darker features of both layers to take precedence. Unlike the Darken composite mode, the result will always be a specific color from either the bottom or top layers.

Difference
The absolute value is taken of the top layer minus the bottom layer, and returned as the result, which is always a positive number. Layer order does not matter. This Blend mode is often used to compare two differently processed versions of the same image to see if there are any alterations, and how large they are.

Divide
Divides the bottom layer by the top layer. Any color divided by itself = 1.0, or white, while any color divided by white (1.0) = itself.

Exclusion
Similar to the Difference composite mode, but results in lower contrast.

Hard Mix
The R, G, and B channel values of the bottom layer are added to the R, G, and B channel values of the top layer. Layer order does not matter. Can result in extreme effects.

Hardlight
Hardlight is the opposite of Overlay. All bottom layer pixels above 50% are Multiplied, while all bottom layer pixels 50% and below are Screened.

Hue
Recombines two layers using HSL image components, by combining the Luma and Saturation of the bottom layer, with the Hue of the top layer.

Lighten
Each pair of pixels in each color channel is compared, and the lighter of the two is the output. Layer order does not matter. Lighten is useful when you want the lightest features of both layers to take precedence, but the output for any given pixel may be a color that doesn’t actually exist for that pixel in either of the source layers.

Lighter Color
For each pair of pixels, all three color channels from the bottom layer are added together, and all three color channels from the top layer are added together. These results are compared, and the lighter pixel of the two layers is the output. Layer order does not matter. Lighten Color is useful when you want the lighter features of both layers to take precedence. Unlike the Lighten composite mode, the result will always be a specific color from either the bottom or top layers.
**Linear Burn**
Each pair of pixels is summed, and 1 is subtracted from the total. Layer order does not matter. Regions of white in one layer let the other layer show through, while colors and darker tones from both layers interact to tint or darken the resulting image.

**Linear Dodge**
Each pair of pixels is summed. This composite mode is identical to Add.

**Linear Light**
All regions where the bottom layer is above 50% are Linear Dodged so as to lighten these parts of the final result, while all regions where the bottom layer is below 50% are Linear Burned so as to darken these parts of the final result. This composite mode intensifies image contrast in the final result.

**Luminosity**
Recombines two layers using HSL image components by combining the Hue and Saturation of the bottom layer with the Luma of the top layer.

**Multiply**
Each pair of pixels is multiplied together. Layer order does not matter. This generally has the effect of emphasizing the darkest parts of both images in the resulting output; in particular black areas of either image are preserved (0 * n = 0) while white areas of either image have no effect on the output image (1 * n = n). Multiply is good for compositing darker elements in a field of white into an image, and can be used to emphasize the darkest parts of a noise, grain, or damage layer you're blending with an image.

**Overlay**
Overlay combines useful aspects of both the Screen and Multiply composite modes, based on the pixel values of the bottom-most image on the Timeline; all bottom layer pixels above 50% are Screened, while all bottom layer pixels 50% and below are Multiplied. Overlay is an excellent composite mode for combining a layer of noise, grain, or damage imagery with another clip, as it combines both images in visually useful ways throughout the tonal range of shadows through highlights.

**Pin Light**
In regions where bottom layer pixels are below 50% gray, lighter pixels in the top layer are replaced by darker pixels from the bottom layer, and darker pixels in the top layer replace lighter pixels in the bottom layer, so that the darker half of the final image combines darker pixels from both layers. In regions where bottom layer pixels are above 50% gray, darker pixels in the top layer are replaced by lighter pixels from the bottom layer, and lighter pixels in the top layer replace darker pixels from the bottom layer, so that the brighter half of the final image combines lighter pixels from both layers.

**Saturation**
Recombines two layers using HSL image components, by combining the Luma and Hue of the bottom layer, with the Saturation of the top layer.

**Screen**
The pixel values of each layer are inverted, then multiplied, and the result is itself inverted. Layer order does not matter. Screen is the inverse of Multiply, as it preserves the lightest parts of both images, and is useful when compositing lighter elements in a field of black into an image, and can be used to emphasize the lightest parts of a noise, grain, or damage layer you're blending with an image.

**Softlight**
A less intense method of applying the Hardlight composite mode that results in a more even blend between the two layers.
Subtract
Within each pair of pixels, those of the bottom layer are subtracted from those of the top. This can result in dark areas of the image that hit flat black, but image data going below 0 is preserved and may be retrieved by later color correction operations.

Vivid Light
All regions where the bottom layer is above 50% are Color Dodged so as to lighten these parts of the final result, while all regions where the bottom layer is below 50% are Color Burned so as to darken these parts of the final result. This composite mode vastly intensifies both image contrast and saturation in the final result, for an extreme effect.

Unknown
When importing XML or AAF project files with composite modes that aren’t available in DaVinci Resolve, the Composite Mode pop-up menu is set to Unknown; practically, this is the same as Normal.

Opacity
Each clip has an Opacity parameter, available in the Inspector, that lets you make it more transparent, in a range from 0 (totally transparent) to 100 (totally opaque). When set to a value less than 100, the selected clip is mixed with whatever clip is underneath it on the Timeline, according to the composite mode that’s currently used. If no clip appears underneath the Timeline, then the clip is mixed with black.

By keyframing this parameter, you can create more complicated fade to black effects or cross dissolves. Keyframing is covered in more detail in Chapter 54, “Keyframing Effects in the Edit Page.”

To change a clip’s opacity:
– Select the clip you want to adjust, open the Composite controls in the Video Inspector, and set the Opacity slider to create the desired amount of transparency.

Video Fader Handles
If you want to dissolve a clip to or from another clip, or to or from black, the traditional way to do so has been to use one of the transitions in the Effects Library. However, you can also use fader handles that appear at the beginning and end a clip when you position the pointer right over it. Fader handles are a fast, ubiquitous method of creating a fade to or from black. However, they also make it easy to fade to or from other clips that are underneath one that’s superimposed, as seen in the following screenshot.

Dragging a video fader handle on a clip in track V2

To use a fader handle, move the pointer over the clip you want to adjust, and when small white fader handles appear at the upper left and upper right of the video of the clip, drag them to the left or right for the duration you want the fade effect to last.
Fade In and Out to Playhead Commands

A pair of commands in the Trim menu let you use the playhead position over a clip to “Fade In to Playhead” or “Fade Out to Playhead.” This can be done for a single clip or for multiple superimposed clips.

These commands work for both audio and video items, in both the Edit and Fairlight pages.

Alpha Channel Support

If a superimposed video or still image clip in the Timeline has an embedded alpha channel, that alpha channel automatically creates transparency within that clip, compositing it against whatever is in the track underneath. There’s no need for you to do anything for this to work.

However, if you need to disable or alter the interpretation of an alpha channel for any clip, for example if a clip is being interpreted as having an alpha channel of the wrong type, you can right-click that clip, choose Clip Attributes from the contextual menu, and use the Alpha Mode pop-up menu of the Clip Attributes Video panel to correct the problem.

**NOTE:** If you’ve imported clips with alpha channels, those alpha channels can be rendered back out for Round Trip workflows. Choose a Format and Codec combination that supports alpha channel output, and turn on the Export Alpha checkbox in the Video panel of the Render Settings list.

Keying in the Timeline Using Resolve FX

You can pull keys directly in the Timeline using the Resolve FX Key filters. These are found in the Resolve FX section of the Open FX category, of the Effects Library. The filter options are 3D Keyer, HSL Keyer, and Luma Keyer. For more information about using Resolve FX Key filters, see Chapter 157, “Resolve FX Key.” Below is an example of using the Resolve FX 3D Keyer filter in the Timeline.

Setting Up a Green Screen (Chroma Key) on the Timeline

To set up a green screen composite, place your background video on a track underneath your foreground video, and drag the 3D Keyer onto the foreground clip.

To adjust the key’s parameters, click on the Effects icon in the Inspector to reveal the Keyer’s controls, and Select “Open FX Overlay” from the Transform Mode drop-down menu in the lower left of the Timeline Viewer, to allow the effect qualifiers to work on the Timeline Viewer.
To pull a Chroma Key in the Timeline using the 3D Keyer.

1. Superimpose your green screened foreground video on a track on top of your background video.

2. Put the Timeline Viewer in Open FX Overlay mode, using the drop-down menu at the lower left of the Viewer. This option allows you to use the effect GUI controls directly on the Viewer.

3. Drag the 3D Keyer from the Effects Library onto the foreground video. The 3D Keyer is a fast and high-quality keyer that’s easy to use, drawing strokes to identify the background and foreground of the image you’re trying to key.

4. Select the foreground video clip, and open the 3D Keyer from the Effects tab in the Inspector.

5. Click the Pick eye dropper icon in the Controls section, and click and drag across the green screen in the Timeline Viewer. A blue line will show you where you’ve selected, and the green screen should mostly become transparent.

6. Optional) Use the Add eye dropper (drawing blue lines), to click and drag over any parts of the green screen that are still not transparent. Use the Subtract eye dropper (drawing red lines) to add back any foreground elements that may have gone transparent by mistake.

7. Turn on the Despill checkbox in the 3D Keyer to remove any green light (spill) that may have reflected onto your foreground subject from the green screen.

Applying the 3D Keyer to the News Anchor clip on the V2 Timeline; note that the “Open FX Overlay” mode on the Viewer is selected (circled), allowing you to use the Inspector Effect controls in the Viewer.

Using Resolve FX and Open FX Alpha for Track Compositing

DaVinci Resolve allows the direct use of the alpha channel from Resolve FX and Open FX plug-ins for compositing on the Timeline. If an effect creates transparency in the image, a “Use alpha” checkbox appears at the bottom of the effects parameters in the Effects tab of the Inspector. Checking this box immediately applies the alpha channel to the selected clip, compositing it over any background elements that appear in lower tracks. If more than one alpha-modifying effect is applied to a single clip, the alpha channels are mixed together.
The Use Alpha checkbox at the bottom of the Effects tab in the Inspector

Transform and Cropping in the Video Inspector

DaVinci Resolve is a resolution-independent application. This means that, whatever the resolution of your source media, it can be output at whatever other resolution you like. This also means that you can freely mix clips of any resolution, fitting 4K, HD, and SD clips into the same timeline, and scaling each to fit the project resolution as necessary.

Your project’s resolution can be changed at any time, allowing you to work at one resolution, and then output at another resolution. This also makes it easy to output multiple versions of a program at different resolutions, for example, outputting both HD and 4K sized versions of the same program.

DaVinci Resolve has a powerful toolset for making geometric transforms, using advanced algorithms for optical-quality sizing operations. Within the Edit page, each clip has a set of transform parameters, principally for use in storing sizing data imported from AAF or XML when you turn on the “Use sizing information” checkbox. This has the advantage of keeping these imported Edit Transform settings separate from the Input Sizing parameters found on the Color page, which are typically used by the colorist to make pan and scan adjustments of various kinds.

Of course, you can also use these controls to create your own adjustments while working in the Timeline, zooming into clips, repositioning them to improve the composition, and so on. While there is some overlap between these parameters and those in the sizing palette of the Color page, they’re both separate sets of parameters, so you can keep each set of adjustments separate.

When the time comes to output your program, the final resolution of each clip is calculated taking into account the original resolution of the source media, the timeline resolution, image scaling settings, Edit page transforms, and Color page transforms, so that the final resolution correctly uses the cleanest geometric transformation based on the maximum resolution available to each source clip.

Transform

The Video Inspector transform group includes the following parameters, which are also editable in the Edit Sizing mode of the Sizing palette in the Color page:

- **Zoom X and Y**: Allows you to blow the image up or shrink it down. The X and Y parameters can be linked to lock the aspect ratio of the image, or released to stretch or squeeze the image in one direction only.
- **Position X and Y**: Moves the image within the frame, allowing pan and scan adjustments to be made. X moves the image left or right, and Y moves the image up or down.
- **Rotation Angle**: Rotates the image around the anchor point.
- **Anchor Point X and Y**: Defines the coordinate on that clip about which all transforms are centered.
- **Pitch**: Rotates the image toward or away from the camera along an axis running through the center of the image, from left to right. Positive values push the top of the image away and bring the bottom of the image forward. Negative values bring the top of the image forward and push the bottom of the image away. Higher values stretch the image more extremely.
– **Yaw:** Rotates the image toward or away from the camera along an axis running through the center of the image from top to bottom. Positive values bring the left of the image forward and push the right of the image away. Negative values push the left of the image away and push the right of the image forward. Higher values stretch the image more extremely.

– **Flip Image:** Two buttons let you flip the image in different dimensions.
  – **Flip Horizontal control:** Reverses the image along the X axis, left to right.
  – **Flip Vertical control:** Reverses the clip along the Y axis, turning it upside down.

### Smart Reframe (Studio Only)

The Smart Reframe feature makes it easier to quickly reframe material across extreme aspect ratio changes. It’s useful for situations where you’ve shot a 16:9 horizontal video and find yourself needing to create a vertically-oriented 9:16 version for mobile phones and social media deliverables, or using 4:3 archival footage in a 2.39:1 widescreen movie. Smart Reframe can be used manually, or automatically executed using the DaVinci Resolve Neural Engine.

– **Object of Interest:** Tools for selecting the subject that the resize will frame around.
  – **Auto:** DaVinci Resolve’s Neural Engine will analyze the clip and choose its most representative object. This will be the only option if more than one clip is selected for Smart Reframing.
  – **Reference Point:** Allows you to manually adjust a bounding box around the subject to reframe around.

– **Reframe:** This button executes the Smart Reframe command. This can take some time depending on the length and number of clips.

### Cropping

The Video Inspector has an additional set of cropping parameters:

– **Crop Left, Right, Top, and Bottom:** Lets you cut off, in pixels, the four sides of the image. Cropping a clip creates transparency, so that whatever is underneath shows through.

– **Softness:** Lets you blur the edges of a crop. Setting this to a negative value softens the edges inside of the crop box, while setting this to a positive value softens the edges outside of the crop box.

### Dynamic Zoom

The Dynamic Zoom controls, which are off by default, make it fast and easy to do pan and scan effects to zoom into or out of a clip. Also, if you import a project from Final Cut Pro X with clips that use the Ken Burns effect, then those clip’s effects will populate the Dynamic Zoom parameters in DaVinci Resolve. Turning the Dynamic Zoom group on activates two controls in the Inspector that work hand-in-hand with the Dynamic Zoom onscreen adjustment controls you can expose in the Timeline Viewer (described below):

– **Dynamic Zoom Ease:** Lets you choose how the motion created by these controls accelerates. You can choose from Linear, Ease In, Ease Out, and Ease In and Out.

– **Swap:** This button reverses the start and end transforms that create the dynamic zoom effect.

### Stabilization

Image Stabilization is available for clips right in the Timeline. These controls let you smooth out or even steady unwanted camera motion within a clip. The analysis is performed in such a way as to preserve the motion of individual subjects within the frame, as well as the overall direction of desirable camera motion, while correcting for unsteadiness.
These are the same stabilizer controls found in the Color page’s Tracker palette (minus the tracker graph), and the resulting stabilization analysis is mirrored on the Color page, where you can see the data visualized on the graph, if necessary.

A pop-up menu provides three different options that determine how the selected clip is analyzed and transformed during stabilization. You must choose an option first, before clicking the Stabilize button above, because the option you choose changes how the image analysis is performed. If you choose another option, you must click the Stabilize button again to reanalyze the clip.

- **Perspective:** Enables perspective, pan, tilt, zoom, and rotation analysis and stabilization.
- **Similarity:** Enables pan, tilt, zoom, and rotation analysis and stabilization, for instances where perspective analysis results in unwanted motion artifacts.
- **Translation:** Enables pan and tilt analysis and stabilization only, for instances where only X and Y stabilization gives you acceptable results.

The other controls let you customize how aggressively the selected clip is stabilized.

- **Stabilization Toggle:** The toggle control for the Stabilization controls lets you turn stabilization off and on to be able to compare the stabilized and unstabilized image.
- **Camera Lock:** Turning on this checkbox disables Cropping Ratio and Smooth, and enables the stabilizer to focus on eliminating all camera motion from the shot in an effort to create a locked shot.
- **Zoom:** When this checkbox is turned on, the image is resized by a large enough percentage to eliminate the blanking (black edges) that is the result of warping and transforming the image to eliminate unwanted camera motion. The lower a value Cropping Ratio is set to, the more DaVinci Resolve will need to zoom into an image to eliminate these blanked edges. If you turn this off, the image is not zoomed at all, and whatever blanking intrudes into the image is output along with the image, on the assumption that you’ll have dedicated compositing artists deal with eliminating this blanking by filling in the missing image data in a more sophisticated manner. You may also leave this checkbox turned off if you’re planning on animating the Input Sizing Zoom parameter to dynamically zoom into and out of a shot being stabilized to eliminate blanking only where it occurs, using only as much zooming as is necessary for each region of the shot.
- **Cropping Ratio:** This value limits how hard the stabilizer tries to stabilize, by dictating how much blanking or zooming you’re willing to accept in exchange for eliminating unwanted motion. A value of 1.0 results in no stabilization being applied. Progressively lower values enable more aggressive stabilization. Changing this value requires you to click the Stabilize button again to reanalyze the clip.
- **Smooth:** Lets you apply mathematical smoothing to the analyzed data used to stabilize the clip, allowing camera motion in the shot while eliminating unwanted jittering. Lower values perform less smoothing, allowing more of the character of the original camera motion to show through, while higher values smooth the shot more aggressively. Changing this value requires you to click the Stabilize button again to reanalyze the clip.
– **Strength**: This value is a multiplier that lets you choose how tightly you want to use the stabilization track to eliminate motion from a shot using the current analysis. With a value of 1, stabilization is maximized. Since some clips might look more natural with looser stabilization, choosing a number lower than 1 lets a percentage of the original camera motion show through. Zero (0) disables stabilization altogether. As an additional tip, you can invert the stabilization by choosing –1 when pasting a stabilization analysis from another clip to perform a match move based on the overall motion of the scene, and you can use a negative value either lower than 0 or higher than –1 to under or overcompensate when inverting the stabilization, simulating the effects of parallax where foreground and background planes move together but at different speeds.

**Lens Correction**

The Lens Correction group (only available in Resolve Studio) has two controls that let you correct for lens distortion in the image, or add lens distortion of your own.

– **Analyze**: Automatically analyzes the frame in the Timeline at the position of the playhead for edges that are being distorted by wide angle lens. Clicking the Analyze button moves the Distortion slider to provide an automatic correction. If you’re analyzing a particularly challenging clip, a progress bar will appear to let you know how long this will take.

– **Distortion**: Dragging this slider to the right lets you manually apply a warp to the image that lets you straighten the bent areas of the picture that can be caused by wide angle lenses. If you clicked the Analyze button and the result was an overcorrection, then dragging this slider to the left lets you back off of the automatic adjustment until the image looks correct.

**Retime and Scaling**

The Retime and Scaling group has four parameters that affect retiming quality and clip scale:

– **Retime Process**: Lets you choose a default method of processing clips in mixed frame rate timelines and those with speed effects (fast forward or slow motion) applied to them, on a clip-by-clip basis. The default setting is “Project Settings,” so all speed-effected clips are treated the same way. There are three options: Nearest, Frame Blend, and Optical Flow, which are explained in more detail in the Speed Effect Processing section of Chapter 52, “Speed Effects.”

– **Motion estimation mode**: When using Optical Flow to process speed change effects or clips with a different frame rate than that of the Timeline, the Motion Estimation pop-up lets you choose the best-looking rendering option for a particular clip. Each method has different artifacts, and the highest quality option isn’t always the best choice for a particular clip. The default setting is “Project Settings,” so all speed-effected clips are treated the same way. There are several options. The “Standard Faster” and “Standard Better” settings are the same options that have been available in previous versions of DaVinci Resolve. They’re more processor-efficient and yield good quality that are suitable for most situations. However, “Enhanced Faster” and “Enhanced Better” should yield superior results in nearly every case where the standard options exhibit artifacts, at the expense of being more computationally intensive, and thus slower on most systems. The Speed Warp setting is available for even higher-quality slow motion effects using the DaVinci Neural Engine. Your results with this setting will vary according to the content of the clip, but in ideal circumstances this will yield higher visual quality with fewer artifacts than even the Enhanced Better setting.

– **Scaling**: Lets you choose how clips that don’t match the current project resolution are handled on a clip-by-clip basis. The default setting is “Project Settings,” so that all mismatched clips use the same method of being automatically resized. However, you can also choose an individual method of automatic scaling for any clip. The options are Crop, Fit, Fill, and Stretch; for more information see the 2D Transforms section of Chapter 150, “Sizing and Image Stabilization.”
– **Resize Filter**: For clips that are being resized in any way, this setting lets you choose the filter method used to interpolate image pixels when resizing clips. Different settings work better for different kinds of resizing. There are four options:

  – **Sharper**: Usually provides the best quality in projects using clips that must be scaled up to fill a larger frame size, or scaled down to HD resolutions.

  – **Smoother**: May provide higher quality for projects using clips that must be scaled down to fit an SD resolution frame size.

  – **Bicubic**: While the Sharper and Smoother options are slightly higher quality, Bicubic is still an exceptionally good resizing filter and is less processor intensive than either of those options.

  – **Bilinear**: A lower quality setting that is less processor intensive. Useful for previewing your work on a low-performance computer before rendering, when you can switch to one of the higher quality options.

  – **Other Resize Methods**: A selection of specific resize algorithms is available if you need to match them to other VFX workflows.

---

**Onscreen Controls for Transform, Crop, and Dynamic Zoom**

You also have the option of transforming, cropping, or adding dynamic zoom effects to clips using the Transform/Crop/Dynamic Zoom button at the bottom left of the Timeline Viewer. These on-screen controls can also be selected by choosing an option from the View > Viewer Overlay submenu; these commands are not mapped to keyboard shortcuts by default, but you can make a manual mapping if there’s a mode you find yourself using regularly. The currently selected overlay can be toggled on and off by pressing Shift-` (Tilde), or by choosing View > Viewer Overlay > Toggle On/Off.

---

**Object Snapping in the Viewer**

While dragging objects or dynamic zoom outlines to reposition them, snapping occurs at the X and Y center of the frame, as well as around the outer third of the frame. Holding the Shift key down while dragging a text object constrains movement to just the X or Y axis.

**Using Onscreen Controls**

For many, the onscreen controls provide a more intuitive experience for manipulating your clips.
To transform a clip using graphical controls in the Timeline Viewer:

1. Click the Transform/Crop button at the bottom left of the Timeline Viewer to turn it on; white is enabled, gray is disabled. When enabled, if no clips are selected in the Timeline, then the clip in the highest auto-select-enabled track that intersects the playhead will display onscreen transform controls. If a clip is selected, that specific clip can be transformed.

2. Do one of the following:
   a. Choose the Transform mode from the pop-up menu, if necessary, to change modes. The appropriate onscreen controls appear to let you manipulate the clip with the mouse. When in Transform mode, you can drag anywhere within the clip’s bounding box to adjust pan and tilt, drag any diagonal corner to proportionally resize, drag any side to squeeze or stretch just width or height, or drag the center handle to rotate.

   ![Onscreen controls for transforming in the Timeline Viewer](image1)

   **Onscreen controls for transforming in the Timeline Viewer**

   b. Choose the Cropping mode from the pop-up menu. In this mode, each side has a handle for cropping.

   ![Onscreen controls for cropping in the Timeline Viewer](image2)

   **Onscreen controls for cropping in the Timeline Viewer**
c. Choose the Dynamic Zoom mode from the pop-up menu. In this mode, the green box shows the starting size and position of the animated transform, while the red box shows the ending size and position of the animated transform. Drag anywhere within either bounding box to adjust pan and tilt for either the start or the end of the animated effect, and drag any of the corners to adjust the size. A motion path appears to show the motion that’s being created. Adjusting the Dynamic Zoom controls automatically enables dynamic zoom in the Inspector.

Onscreen controls for transforming and cropping in the Timeline Viewer

3 If necessary, choose a smaller viewing percentage from the Timeline Viewer scale pop-up to better see the onscreen controls if you’re rescaling the image, or use the scroll control of your mouse, trackpad, or tablet to zoom out of the image.

4 When you’re finished, turn the Transform/Crop/Dynamic Zoom button off.
You can import both linear and nonlinear speed changes from other applications, or you can create these effects from scratch in order to speed up or slow down clips in your programs. DaVinci Resolve has a comprehensive set of controls for creating these kinds of effects using dedicated Retime controls, curves, and specific edit types. Once created, DaVinci Resolve also provides different ways of processing these effects to create the smoothest possible playback.

Contents

- Speed Effects and Retiming 880
- Creating Freeze Frames 880
- Creating Simple Linear Speed Effects 881
- Speed Change Controls in the Video Inspector 882
- Clip Retiming Controls 882
- Retiming an Entire Clip 883
- Rippling or Overwriting the Timeline When Using Retime 883
- Reading Clip Speed Arrows 883
- Creating Variable Speed Effects Using the Retime Controls 884
- Closing Retime Controls 886
- Using Retime Curves 887
- Speed Effect Processing 889
- Optical Flow Quality Settings Affecting Speed Effects 890
Speed Effects and Retiming

Speed effects describe any effect that speeds up, slows down, or otherwise changes the playback speed of clips in the Timeline. There are four basic ways you can create speed effects in DaVinci Resolve.

- **Importing speed effects:** DaVinci Resolve is capable of reading linear speed effects from imported EDL, AAF, and XML projects, and nonlinear speed effects from XML and AAF project files. When speed effects are present, DaVinci Resolve plays clips at the specified speed. You can also create speed effects of your own using controls in the Edit page. There are two methods of adjusting clip speed: using the Change Speed dialog, and using the Retiming effect in the Timeline.

- **Creating speed effects using Fit to Fill edits:** You can also change a clip’s speed in the Timeline by editing it using the Fit to Fill command, which retimes the clip to fit into an arbitrary duration in the Timeline of your choosing. For more information on using Fit to Fill, see Chapter 40, “Three- and Four-Point Editing.”

- **Creating freeze frames:** You can use the freeze frame command to turn an entire clip into a freeze frame of a frame intersecting the playhead.

- **Creating simple linear speed effects:** You can create simple fast or slow-motion speed effects by using the Change Clip Speed command, or by using the left and right handles of the Retime controls in the Timeline. Both of these methods are described in this section.

- **Creating variable speed effects:** You can create much more complex variable speed effects, where the same clip speeds up or slows down multiple times by different amounts, using either the Retime controls, or one of the two different speed curves that are available. These methods are also covered later in this section.

**Speed Effects and Audio**

Any of the methods of creating linear speed effects that are available in DaVinci Resolve, including the Change Clip Speed command, the Retime controls, and the Fit to Fill edit, will retime a clip’s audio, without pitch correction on Linux and Windows, and with pitch correction on Mac OS X (Yosemite and above), along with its video. However, audio that accompanies variable speed effects will be muted.

**Creating Freeze Frames**

There are a few ways you can create a freeze frame, but the fastest is to position the playhead over the frame you want to be the freeze frame, and choose Clip > Freeze Frame, or press Shift-R. The entire clip becomes a freeze frame of the frame you parked the playhead over.

If you want to disable the freeze frame effect, you can select the clip and use the Remove Attributes dialog to remove the speed effect, or you can simply open the Change Clip Speed dialog and turn the Freeze Frame checkbox off.
Creating Simple Linear Speed Effects

If all you need to do is to make a clip play in slow motion, speed it up, reverse the clip, or create a freeze frame, you can apply a simple speed effect using either the browser or the Change Speed dialog.

To change a clip’s speed, do one of the following:
– Select a clip, choose Clip > Change Clip Speed, and use the controls of the Edit Speed Change dialog.
– Right-click a clip in the Timeline, choose Change Clip Speed, and use the controls of the Edit Speed Change dialog.

Change Clip Speed operations have the following options:
– **Change Clip Speed parameters**: Changes the speed of the selected clip by whatever percentage, frame rate, or duration you like.
– **Ripple Sequence checkbox**: If you want the speed change you’re about to make to ripple the Timeline, pushing or pulling all clips following the current one to accommodate the clip’s new size, then turn on the checkbox.

– **Reverse Speed checkbox**: Clicking this box sets the current speed to a negative value, reversing the motion of the clip.
– **Freeze Frame checkbox**: Changes the entire clip to a freeze frame of whichever frame is at the current position of the playhead.
– **Pitch Correction checkbox**: Checking this box will perform pitch correction on the audio attached to the clip so that while the audio duration is changed to match the picture speed, it will still sound natural. Be aware that pitch correction on large speed adjustments may not sound as good as pitch corrections made to small speed adjustments.
– **Maintain Timing/Stretch to fit radio buttons**: Choosing Maintain Timing leaves any keyframes within the clip locked at their original position, while choosing Stretch Keyframes results in all Composite, Transform, and Cropping keyframes being compressed or stretched by the same percentage as the clip during a speed change.
You can also change the speed of your clip directly in the Video Inspector’s Speed Change controls. This method has the benefit of being available in both Cut and Edit pages.

- **Direction**: Selects the desired motion of the clip, forward, backward, or freeze frame.
- **Speed %**: Adjusting this slider changes the clip’s motion on a percentage basis. This value can be keyframed.
- **Frames Per Second**: Adjusting this slider changes the clip’s motion by increasing or decreasing the number of frames per second to play the clip back at. This value can be keyframed.
- **Duration**: You can directly select how long you want the clip to be by setting a specific duration here in HH:MM:SS:FF format. This will then automatically adjust the speed of the clip to playback all frames in that exact amount of time.
- **Ripple Sequence checkbox**: If you want the speed change you’re about to make to ripple the Timeline, pushing or pulling all clips following the current one to accommodate the clip’s new size, then turn on the checkbox.
- **Pitch Correction checkbox**: Checking this box will perform pitch correction on the audio attached to the clip so that while the audio duration is changed to match the picture speed, it will still sound natural. Be aware that pitch correction on large speed adjustments may not sound as good as pitch corrections made to small speed adjustments.

### Clip Retiming Controls

Another method of altering clip speed in the Timeline is to apply the Retime effect. This method of clip retiming provides a convenient control overlay that you can use to adjust clip speed directly in the Timeline, and it also provides the controls that are needed for creating variable-speed effects.

**To expose the Retime controls on a clip:**

- Select a clip, and choose Clip > Retime Controls (Command-R).
- Right-click a clip and choose Retime Clip from the contextual menu.

The Retime controls appear over that clip in the Timeline. They consist of a Retime control track running along the top of the clip with arrows that indicate the speed and direction of playback (the default blue right-facing arrows indicate normal 100% playback) and a Clip Speed pop-up menu at the bottom center of the clip, which also shows the current speed of the clip.
Retiming an Entire Clip

The simplest way of using the Retiming effect is to change the playback speed of the entire clip, in the process rippling the rest of the Timeline to the right of the retimed clip as you increase its duration by stretching or compressing its duration.

To retime a clip by dragging:
– Move the pointer to the left or right edge of the Speed Change name bar on top of the clip, and when it turns into a Retime cursor, drag either side to stretch or squeeze the clip to retime it.

To retime a clip by specific amounts:
1 Select a clip and press Command-R.
2 Click the pop-up next to the speed percentage text at the bottom of the clip.
3 Do one of the following:
   – Choose a new playback speed from the Change Speed submenu.
   – Choose reverse segment to make the clip play in reverse. Reverse speed is shown in the Retime control track as arrows facing left, instead of right.

To return a clip to its original speed:
– Click the pop-up next to the speed percentage text at the bottom of the clip, and choose Reset to 100%.

Rippling or Overwriting the Timeline When Using Retime

Whether or not clips to the right in the Timeline will ripple to accommodate the change in duration resulting in speed changes you make with the Retime controls depends on whether you’re using the Selection tool/mode (in which case the Timeline won’t ripple), or the Trim tool/mode (in which case the Timeline will).

Reading Clip Speed Arrows

When you retime a clip, the Clip Speed pop-up menu displays the current speed of the entire clip. Additionally, the arrows in the Retime control track show you the speed and direction of playback. When clip speed is slowed down below 100%, the Retime control track shows yellow playback triangles that are spaced farther apart. When clip speed is sped up above 100%, the Retime control track shows blue triangles that are bunched closer together. At 100% normal speed, the Retime control track shows blue, evenly spaced triangles, while left-facing blue arrows indicates reverse playback.
Creating Variable Speed Effects Using the Retime Controls

You can also use the Retime controls to insert freeze frames within the middle of a clip, and create other custom variable speed effects using speed points. Additional variable speed options include rewind and speed ramp effects, which automatically place speed points to create preset effects.

To create a freeze frame at a particular moment in time:

1. With the Retime controls exposed, move the playhead to the frame you want to freeze, within that clip. Ideally, this will be for an effect where you want a character in motion to suddenly stop at a particular frame.

2. Open the Clip Speed pop-up menu (the pop-up next to the speed percentage text at the bottom of the clip), and choose Freeze Frame. Two new speed points are added to the clip, defining a range within which the clip is frozen at that frame. This can be seen by the vertical red bars in the Retime control track. Past the second speed point, the clip resumes playback from the next frame forward.

3. Drag the second speed point forward or back to define the duration of the freeze frame. The result is that the clip plays normally up until the first speed point, then freezes on that frame until the second speed point, at which playback resumes.

To create variable-speed effects:

1. With the Retime controls exposed, move the playhead to the frame at which you want to change the speed of the clip, and choose Add Speed Point from the Clip Speed pop-up menu.

2. Move the playhead forward to the next frame at which you want the clip speed to change again, and add another speed point. It takes a minimum of two speed points to create a speed effect.

3. To alter the speed of the clip segment appearing between these two speed points, do one of the following:
Using the pointer, drag the top handle of the second speed point to the right to slow down clip playback, or to the left to speed up clip playback within just that segment. Doing this either shortens or lengthens the clip, and either overwrites or ripples neighboring clips depending on whether you’re using the Selection or Trim modes.

Also using the pointer, you can drag the bottom handle of any speed point to widen the range of the clip that plays at that particular speed. Doing this reallocates frames from before and after the speed segment being adjusted to keep all speed segments playing at the same speed, and this also shortens or lengthens the clip, but by a different amount.

Using the Clip Speed pop-up menu, choose a new speed for that segment from the Change Speed pop-up menu. You can also set any segment to play in reverse by choosing Reverse Segment.

To clear a speed point and eliminate that particular clip’s speed segment from the effect, choose Clear Speed Point from any Clip Speed pop-up menu to eliminate whichever speed point appears to its left.

When you create variable-speed effects, the arrows in the Retime control track can help you keep track of what you’re doing, and each segment’s speed pop-up shows you the actual numeric speed. The change in speed from each speed segment to the next is automatically eased, for a smooth transition from one speed to another.

To add a rewind effect:

With a clip’s Retime controls exposed, open any Clip Speed pop-up menu and choose a preset percentage from the Rewind submenu. This results in two additional speed points being added after the rightmost speed point in the current segment, which creates the effect of the current segment playing in fast reverse for the chosen percentage, and then playing a second time from the beginning.
To add a speed ramp:

With a clip’s Retime controls exposed, open any Clip Speed pop-up menu and choose one of the two options from the Speed Ramp submenu to replace the current speed effect with a series of five speed segments that start at 10% and increase progressively to 30%, 50%, 70%, and then 90%. Once created, you can drag the speed points to customize this effect to create whatever durations you require.

Closing Retime Controls

When you’re finished creating your Retime effect, you can close the Retime controls so that clip assumes a normal appearance again. Closing the Retime controls has no effect on the timing of the clip, it just ensures you cannot accidentally modify the speed of the clip with the mouse.

To close the Retime controls in the Timeline:

– Click the X button at the upper left-hand corner of the Retime control box.
– Press the escape key.
– Select the retimed clip, and either choose Clip > Retime Controls, or press Command-R.

When a retimed clip has its Retime controls hidden, a Retime badge appears to the left of that clip’s name in the Timeline. You can reopen the Retime controls whenever you need to make further changes.
To reopen the Retime controls in the Timeline:

– Select the retimed clip, and either choose Clip > Retime Controls, or press Command-R.

Once you’ve retimed a clip using the Retime effect, you can use that clip’s Retime Process parameter in the Inspector to define how that clip’s retiming is processed, using the low quality Nearest option, using Frame Blending, or using Optical Flow.

Using Retime Curves

You can also optionally use curves to retime clips, either in conjunction with the Retime controls, or by themselves. For example, you can use the simpler retiming controls first to create the overall speed effect you need, and then use either of the available Retime Curves to create further refinements by adjusting Bezier curve handles to adjust the transition of one speed to another, or you can expose either of the Retime Curves first and use it to create your speed effect from scratch by adding and adjusting control points and curve segments.

No matter how you like to work, the control points of each of the speed curves have a 1:1 correspondence to the speed points that are exposed in the Retime controls, and curve segment modifications are mirrored by speed point adjustments in the Retime controls if you have both exposed at the same time. This means that, when creating complex variable retiming effects, it’s easy to drag whichever control most easily adjusts the quality of speed you require.

In addition, there are two kinds of Retime curves you can use for maximum flexibility. Which is best depends on what you’re more comfortable with, and on which will handle the type of motion you want to create more easily:

– The Retime Frame curve exposes a diagonal line that represents a time graph. This is a type of curve found in many other post-production applications, in which the vertical axis represents each frame of that clip’s source media, and the horizontal axis represents each frame of playback in the Timeline. With the default diagonal graph, there is a one-to-one correspondence between each frame of source media and each frame of timeline playback; this represents 100% speed. However, adding control points lets you alter how source frames are mapped to the Timeline. For any two control points on the Retime Frame curve, so long as the control point at the left is lower than the control point at the right of a curve segment, there will be forward motion, with longer shallow curve segments creating slower motion, and steeper shorter curve segments creating faster motion in the clip.
A diagonal Retime Frame curve with two segments: a long shallow segment to the left that creates slow motion, and a short steep segment to the right that creates fast motion.

- If a curve segment has a left control point that’s higher than the right control point, then the motion will be reversed and that segment will play backward.

A Retime Frame curve with an inverted curve that creates reverse motion.

- The Retime Speed curve (seen below) exposes a flat line that represents 100% speed. Adding pairs of control points and dragging each segment to raise or lower it alters speed; you must drag the segments, not the control points themselves. Raising a curve segment shortens that segment and speeds up that portion of the clip, while lowering a curve segment lengthens that segment and slows down that portion of the clip. As you adjust each curve segment, a tooltip shows you the exact speed percentage that segment represents. You should note that it’s impossible to create reverse motion using the Retime Position curve; you need to use either the Retime controls or the Retime Speed curve described above.
Methods of working with speed curves:

– **To expose speed curves for a clip in the Timeline:** Right-click a clip in the Timeline, and choose Retime Curve. The Curve Editor is exposed for that clip, and you can edit it as you would any other curve, adding moving, and deleting control points.

– **To switch between editing Retime Speed and Retime Frame curves:** Use the Curve pop-up at the upper left-hand corner of the Curve Editor to check or uncheck the curves you want to be visible. Clicking on a curve within the editor makes that curve the currently edited one.

– **To close a speed curve:** Clicking the Curve button at the right-hand side of the clip's title bar in the Timeline toggles the curve open and closed.

As far as adding, removing, and smoothing control points on speed curves and adjusting curve segments, they work identically to any other curve in the Timeline. For more information, see “Keyframing in the Timeline and Curve Editor” in Chapter 54, “Keyframing Effects in the Edit Page.”

### Speed Effect Processing

Once you’ve retimed a clip, you have the additional ability to change how the retimed clip is processed in order to improve its visual playback quality, especially in the case of clips that are slowed down. There are two ways you can set this. First, there’s a project-wide setting available in the Master Settings of the Project Settings. Secondly, you can change how clips are retimed via a per-clip setting available in the Inspector.

**To change the Retime Process setting of an entire project:**

1. Open the Project Settings and click to open the Master Settings panel.
2. Choose an option from the Frame Interpolation group Retime Process pop-up menu.

**To change an individual clip’s Retime Process setting:**

– Select a clip, then open the Inspector and choose an option from the Retime Process pop-up in the Retime and Scaling group. If you choose Optical Flow, you can also choose an option from the Motion Estimation pop-up.

Here are the different options you have for processing speed effects:

– **Retime Process:** Lets you choose a default method of processing clips in mixed frame rate timelines and those with speed effects (fast forward or slow motion) applied to them, on a clip-by-clip basis. The default setting is “Project Settings,” so all speed effected clips are treated the same way. There are three options: Nearest, Frame Blend, and Optical Flow, which are explained in more detail in the Frame Interpolation section of Chapter 4, “System and User Preferences.”

– **Nearest:** The most processor efficient and least sophisticated method of processing; frames are either dropped for fast motion, or duplicated for slow motion.

– **Frame Blend:** Also processor efficient, but can produce smoother results; adjacent duplicated frames are dissolved together to smooth out slow or fast motion effects. This option can provide better results when Optical Flow displays unwanted artifacts.

– **Optical Flow:** The most processor intensive but highest quality method of speed effect processing. Using motion estimation, new frames are generated from the original source frames to create slow or fast motion effects. The result can be exceptionally smooth when motion in a clip is linear. However, two moving elements crossing in different directions or unpredictable camera movement can cause unwanted artifacts.
– **Motion estimation mode:** When using Optical Flow to process speed change effects or clips with a different frame rate than that of the Timeline, the Motion Estimation pop-up lets you choose the best-looking rendering option for a particular clip. Each method has different artifacts, and the highest quality option isn’t always the best choice for a particular clip. The default setting is “Project Settings,” so all speed effected clips are treated the same way. There are several options.

– “Standard Faster” and “Standard Better” are the same options that have been available in previous versions of DaVinci Resolve. They’re more processor-efficient and yield good quality that are suitable for most situations.

– “Enhanced Faster” and “Enhanced Better” should yield superior results in nearly every case where the standard options exhibit artifacts, at the expense of being more computationally intensive, and thus slower on most systems.

– “Speed Warp” is available for even higher-quality slow motion effects using the DaVinci Neural Engine. Your results with this setting will vary according to the content of the clip, but in ideal circumstances this will yield higher visual quality with fewer artifacts than even the Enhanced Better setting. This setting is only available on a clip-by-clip basis; it’s not available in the Project Settings.

### Optical Flow Quality Settings Affecting Speed Effects

The “Motion estimation mode” pop-up in the Master Settings panel of the Project Settings let you choose the tradeoff between quality and processing speed to use when processing optical flow-based slow motion and frame rate retiming effects. The “Standard Faster” and “Standard Better” settings are the same options that have been available in previous versions of DaVinci Resolve. They’re more processor-efficient and yield good quality that are suitable for most situations. However, “Enhanced Faster” and “Enhanced Better” should yield superior results in nearly every case where the standard options exhibit artifacts, at the expense of being more computationally intensive, and thus slower on most systems.
DaVinci Resolve supports subtitles and closed captioning in sophisticated ways. With dedicated subtitle/closed caption tracks that can be shown or hidden, subtitle file import and export, sophisticated subtitle editing and styling at the track and clip level, and comprehensive export options, adding subtitles and closed captions to finish your project is a clear and straightforward workflow.

Contents

- Subtitles and Closed Captioning Support 892
- Viewing Subtitle/Caption Tracks 892
- Adjusting QC Thresholds For Subtitle/Caption Timing 892
- Importing Subtitles and Captions 893
- Adding Subtitles and Captions Manually 895
- Editing Subtitles and Captions 897
- Styling Subtitles and Captions 897
- Linking Subtitles to Clips 898
- Naming Subtitle Tracks 898
- Exporting Subtitles and Closed Captions 900
- Exporting Subtitles Via the File Menu 900
- Exporting Subtitles Via the Subtitle Track Header 900
- Exporting, Burning, or Embedding Subtitles During Delivery 900
Subtitles and Closed Captioning Support

Subtitles are supported in DaVinci Resolve using specially typed subtitle tracks containing specifically designed subtitle generators to add and edit subtitles for a program. Typically each subtitle track corresponds to a single language or use, and you can change the name of a subtitle track to reflect its contents.

Subtitle tracks can be locked, have Auto Select controls, and can be enabled or disabled like any other track. Additionally, a special subtitle-only destination control lets you choose which subtitle track to edit subtitle clips into. Furthermore, subtitle generator clips can be resized, moved, edited, and overwritten like most other clips.

Viewing Subtitle/Caption Tracks

One important difference between subtitle tracks and other kinds of tracks is that only one subtitle track can be visible at any given time. That means if you have multiple subtitle tracks, each for a different language, clicking the Enable control for one subtitle track disables all others.

Adjusting QC Thresholds For Subtitle/Caption Timing

To help you adhere to guidelines that specify the recommended duration, line length, and speed of captions and subtitles, the Subtitles panel of the Project Settings has parameters you can set to warn you when a particular subtitle clip exceeds thresholds of Characters Per Line, Minimum Caption Duration, and Maximum Characters Per Second.
As you edit a subtitle clip, these thresholds are used to automatically calculate how many lines and characters are allowable for a particular subtitle clip given its duration. For example, if you exceed the calculated threshold, the CPS value of that caption turns red to warn you.

The CPS value of a subtitle has turned red because it exceeds the current QC threshold.

**Importing Subtitles and Captions**

Oftentimes, adding subtitles or closed captions to a DaVinci Resolve timeline will involve importing a subtitle file that’s been prepared elsewhere. Currently, DaVinci Resolve supports subtitle files in the .srt SubRip format.

**To import an .SRT-formatted subtitle or closed captioning file:**

1. Open the Media Pool.
2. Right-click on any bin in the Bin list, or anywhere in the background of the Media Pool browser, and choose Import Subtitle.
3. In the resulting file dialog, find and select the subtitle file you want to import, and click Open.
4. The subtitle file appears as a subtitle clip in the Media Pool, ready for editing into a subtitle track. A badge indicates that it’s a subtitle clip.

An imported .srt subtitle file

5. To add a subtitle clip to a timeline, do one of the following:
   - Drag a subtitle file you’ve imported into the unused gray area at the top of your video tracks, and a subtitle track will automatically be created for adding those subtitles into
   - Drag a subtitle file you’ve imported into a pre-existing subtitle track

As you drag the subtitle clip, it’ll immediately be decomposed so that each title is added to the Timeline as an individual subtitle clip, with its timing offset relative to the position of the first frame of the first subtitle in that file.
6 Position the imported subtitles so that they align with the first frame of your program that they’re supposed to, and drop the titles into the track. If you inadvertently misplace the subtitles, don’t worry, you can always select them all and slide them earlier or later, just like any other clips.

7 If you’ve added a new subtitle track, you can rename it to identify what language and country that track corresponds to. Please note that subtitle track names are used when exporting or encoding subtitles, so please make sure your tracks are named appropriately prior to export/delivery.

8 If you want to restyle all of the subtitles you’ve just added, for example to make them smaller or change the font, then click on the header of the subtitle track you’ll be working on, open the Track Style panel of the Inspector, and select the formatting you want that track to use.

To see a list of every subtitle clip you’ve added, you can select the header of the subtitle track you’ve just added and open the Captions panel in the Inspector. A list at the bottom of the Captions panel gives you a convenient way of navigating the subtitles in a given track (using the Prev and Next buttons) and making selections. If you set the Inspector to be full height, you’ll have even more room for browsing the subtitle list.
Adding Subtitles and Captions Manually

Other times, you may need to create subtitles on your own. Before doing so, you’ll need to add one or more subtitle tracks. Once those tracks are created, you can add subtitle generators to them in a variety of ways. You can add as many subtitle tracks as you need, one for each language you require.

To add new subtitle tracks:

– Right-click in any track header of the currently open timeline, and choose Add Subtitle Track. An empty subtitle track will appear at the top of the Timeline, named “Subtitle 1,” and if Subtitle Tracks were hidden, they’re now shown. Once you’ve added a new subtitle track, you can rename it to identify what language and country that track corresponds to. Please note that subtitle track names are used when exporting or encoding subtitles, so please make sure your tracks are named appropriately prior to export/delivery.

You can show and hide subtitle tracks in case you need to free up room in the Timeline for working on other tracks. Subtitles on the currently selected subtitle track continue to be visible, however, regardless of whether or not the subtitle tracks are shown.

Showing and hiding subtitles tracks:

– Open the Timeline View options, and click on the Subtitle button to toggle the visibility of subtitles tracks on and off.

To add individual subtitles to a subtitle track:

1 If you want to adjust the default style of a particular subtitle track before you start adding subtitles, then click on the header of the subtitle track you’ll be working on, open the Track Style panel of the Inspector, and select the formatting you want that track to use.

2 If you have multiple subtitle tracks, click the destination control of the subtitle track you want to add titles to. They’re labeled ST1, ST2, ST3, etc.

3 Move the playhead to the frame where you want the new subtitle to begin.

4 To add a new subtitle clip, do one of the following:
Open the Inspector and click Create Caption in the Captions panel of the Inspector. If there’s already one or more captions in that subtitle track, click the Add New button above the caption list, instead.

Right-click anywhere on the subtitle track and choose Add Subtitle to add a subtitle clip starting at the position of the playhead.

Open the Effects Library, click the Titles category, and drag a Subtitle generator to the Subtitle track you want it to appear on.

If necessary, you can now edit the clip to better fit the dialog that’s being spoken or the sound that’s being described, by dragging the clip to the left or right, or dragging the beginning or end of the clip to resize it.

While the new subtitle clip you’ve created is selected, use the Captions panel in the Inspector to type the text for that particular subtitle. The text appears on the subtitle clip as you type it.

Every time you add a subtitle, an entry is added to the subtitle list at the bottom of the Captions panel in the Inspector. This list gives you another convenient way of navigating the subtitles in a given track (using the Prev and Next buttons) and making selections.
Editing Subtitles and Captions

Subtitle clips can be selected singly or together, and slipped, slid, resized, rolled, and rippled just like any other clip in the Timeline, using the mouse or using keyboard commands, with either the Selection, Trim, or Razor tools. You can select subtitle clips in their entirety, or just their edit points, in preparation for nudging or dynamic trimming. In short, subtitle clips can be edited, in most ways, just like any other clips.

Styling Subtitles and Captions

When it comes to styling subtitle text, there are a wealth of styling controls in the Track Style panel of the Inspector.

To modify the styling of all titles on a particular subtitle track:

1. Click on the header of the subtitle track you’ll be working on, or select a clip on a particular subtitle track either in the subtitle track or in the subtitle list of the Captions panel in the Inspector.

2. Open the Inspector, and then open the Track Style panel that appears within.

3. Edit whatever parameters you need to set the default style of all subtitles and closed captions that appear on that track. The Track Style panel has many more options than the Captions panel, including a group of Style and Position controls over Font and Font Face, Color, Size, Line Spacing, and Kerning, Alignment, Position X and Y, Zoom X and Y, Opacity, and Text Anchoring.

The Track Style panel of the Inspector sets styling for every subtitle on that track.

Keep in mind that there are additional groups of controls that let you add a Drop Shadow, Stroke, and/or Background to all text on that track, which can be found at the bottom of the Track Style panel of the Inspector.
Linking Subtitles to Clips

If you like, you can link one or more subtitles to their accompanying clip, so that if you re-edit a subtitled scene, each clip’s subtitles move along with the clips. This arrangement doesn’t always work the way you’d expect when trimming, but it works great when you’re rearranging clips.

To link a subtitle to another clip:

1. Select a clip and its subtitles all at once.

2. Choose Clip > Linked Clips (Option-Command-L). A Link icon appears to show that the subtitle clips are linked to the video/audio clip.

Naming Subtitle Tracks

If necessary, you can double-click the name of any subtitle track to rename it to something more descriptive of what that subtitle track will contain, such as the language, and whether a particular track is for subtitles or closed captions.

Depending on your workflow and delivery specifications, there are existing conventions for identifying languages, such as ISO-639-1 (governing 2-letter codes) or ISO-639-2/B (governing 3-letter codes). These codes can be found at the International Organization for Standardization website, at http://www.loc.gov/standards/iso639-2/php/code_list.php.

Some naming conventions require both language code and country code. For example, Facebook requires SubRip (.srt) files with the naming format “VideoFilename.[language code]_[country code].srt” for proper embedding.

If you want to use these codes for subtitle track identification and output, here’s a representative list of standardized language and country codes from around the world, in alphabetical order:
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Amharic</td>
<td>am</td>
<td>amh</td>
<td>ET (Ethiopia)</td>
</tr>
<tr>
<td>Arabic</td>
<td>ar</td>
<td>ara</td>
<td>EG (Egypt)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>AE (United Arab Emirates)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>LB (Lebanon)</td>
</tr>
<tr>
<td>Bengali</td>
<td>bn</td>
<td>ben</td>
<td>IN (India)</td>
</tr>
<tr>
<td>Chinese</td>
<td>zh</td>
<td>chi (B)</td>
<td>CN (China)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>zho (T)</td>
<td>HK (Hong Kong)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>TW (Taiwan)</td>
</tr>
<tr>
<td>Danish</td>
<td>da</td>
<td>dan</td>
<td>DK (Denmark)</td>
</tr>
<tr>
<td>Dutch</td>
<td>nl</td>
<td>dut (B)</td>
<td>NL (Netherlands)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>nid (T)</td>
<td></td>
</tr>
<tr>
<td>English</td>
<td>en</td>
<td>eng</td>
<td>GB (UK)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IN (India)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>US (US)</td>
</tr>
<tr>
<td>Finnish</td>
<td>fi</td>
<td>fin</td>
<td>FI (Finland)</td>
</tr>
<tr>
<td>French</td>
<td>fr</td>
<td>fre (B)</td>
<td>CA (Canada)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>fra (T)</td>
<td>FR (France)</td>
</tr>
<tr>
<td>German</td>
<td>de</td>
<td>ger (B)</td>
<td>DE (Germany)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>deu (T)</td>
<td></td>
</tr>
<tr>
<td>Greek Modern</td>
<td>el</td>
<td>gre (B)</td>
<td>GR (Greece)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ell (T)</td>
<td></td>
</tr>
<tr>
<td>Hausa</td>
<td>ha</td>
<td>hau</td>
<td>NG (Nigeria)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>TD (Chad)</td>
</tr>
<tr>
<td>Hebrew</td>
<td>he</td>
<td>heb</td>
<td>IL (Israel)</td>
</tr>
<tr>
<td>Hindi</td>
<td>hi</td>
<td>hin</td>
<td>IN (India)</td>
</tr>
<tr>
<td>Indonesian</td>
<td>id</td>
<td>ind</td>
<td>ID (Indonesia)</td>
</tr>
<tr>
<td>Italian</td>
<td>it</td>
<td>ita</td>
<td>IT (Italy)</td>
</tr>
<tr>
<td>Japanese</td>
<td>ja</td>
<td>japon</td>
<td>JP (Japan)</td>
</tr>
<tr>
<td>Malay</td>
<td>ms</td>
<td>may (B)</td>
<td>MY (Malaysia)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>msa (T)</td>
<td></td>
</tr>
<tr>
<td>Maori</td>
<td>mi</td>
<td>mao (B)</td>
<td>NZ (New Zealand)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>mri (T)</td>
<td></td>
</tr>
<tr>
<td>Norwegian</td>
<td>no</td>
<td>nor</td>
<td>NO (Norway)</td>
</tr>
<tr>
<td>Polish</td>
<td>pl</td>
<td>pol</td>
<td>PL (Poland)</td>
</tr>
<tr>
<td>Portuguese</td>
<td>pt</td>
<td>por</td>
<td>BR (Brazil)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PT (Portugal)</td>
</tr>
<tr>
<td>Punjabi</td>
<td>pa</td>
<td>pan</td>
<td>IN (India)</td>
</tr>
<tr>
<td>Russian</td>
<td>ru</td>
<td>rus</td>
<td>RU (Russia)</td>
</tr>
</tbody>
</table>
Exporting Subtitles and Closed Captions

Once you've created one or more subtitle tracks filled with subtitles or captions, there are a few different ways you can export subtitles once you've created them.

**Exporting Subtitles Via the File Menu**

Choose File > Export Subtitle, and use the export dialog to choose a location and file type for the exported subtitle file. You can export subtitles in the .srt and .webvtt formats.

**Exporting Subtitles Via the Subtitle Track Header**

Right-click on the track header of a subtitle track, and choose Export Subtitle from the contextual menu. Use the export dialog to choose a location and file type for the exported subtitle file. You can export subtitles in the .srt and .webvtt formats.

**Exporting, Burning, or Embedding Subtitles During Delivery**

When you've set up one or more subtitle tracks in a program, the Deliver page exposes a group of Subtitle Settings at the bottom of the Video panel of the Render Settings that control if and how subtitles or closed captions are output along with that timeline.

![Export Subtitle dialog](image)

Available options for exporting subtitles can be found at the bottom of the Video panel of the Render Settings.
This panel has the following controls:

- **Export Subtitle checkbox:** Lets you enable or disable subtitle/closed caption output.
- **Format pop-up:** Provides four options for outputting subtitles/closed captions.
  - **As a separate file:** Outputs each subtitle track you select as a separate file using the format specified by the Export As pop-up. A set of checkboxes lets you choose which subtitle tracks you want to output.
  - **Burn into video:** Renders all video with the currently selected subtitle track burned into the video.
  - **As embedded captions:** Outputs the currently selected subtitle track as an embedded metadata layer within supported media formats. There is currently support for CEA-608 closed captions within MXF OP1A and QuickTime files. You can choose the subtitle format from the Codec pop-up that appears.
  - **Export As:** (only available when Format is set to “As a separate file”) Lets you choose the subtitle/closed captioning format to output to. Options include SRT and WebVTT.
  - **Include the following subtitle tracks in the export:** (only available when Format is set to “As a separate file”) A series of checkboxes lets you turn on which subtitle tracks to output.
  - **Codec:** (only available when Format is set to “As embedded captions”) Lets you choose how to format embedded closed captions; choices include Text and CEA-608.

**NOTE:** Neither analog (Line 21) nor digital (CEA-708) closed caption output via Decklink or UltraStudio is supported at this time.
Chapter 54

Keyframing Effects in the Edit Page

The Edit page also provides controls for keyframing effects that you add to your timeline, as well as a curve editor to fine-tuning the motion effects you create right in the Editing Timeline.

Contents

Keyframing Effects in the Edit Page 903
Keyframing in the Video Inspector 904
Keyframing Motion Paths in the Timeline Viewer 906
Keyframing in the Edit Timeline and Curve Editor 908
The Keyframe Editor 908
The Curve Editor 910
Keyframable Open FX and Resolve FX 913
Keyframing Effects in the Edit Page

Most parameters in the Inspector of the Edit page can be keyframed, in order to create animated effects such as zooming in via the Zoom parameter, fading out via the Opacity parameter, or cropping from one side to reveal a clip underneath via the Cropping parameters. Additionally, if you import a project from an NLE that has keyframed sizing settings, those keyframes will be imported and exposed within the Edit page of DaVinci Resolve.

The primary controls for keyframing are within the Video Inspector. Any parameter that can be keyframed has a gray keyframe button to the right of its slider. If the playhead is on a keyframe, this button turns orange and small navigation arrows appear to its right and left, otherwise it stays gray.

Once you’ve keyframed one or more parameters within a particular group in the Inspector, that clip displays a pair of small buttons at the far right of its name bar in the Timeline, a Curve button and a Keyframe button. Only keyframed clips have these buttons.

To expose a clip’s keyframe tracks, do one of the following:

- Click the Keyframe button for that clip, at the bottom right corner of the clip.
- Choose Clip > Show Keyframe Editor (Shift-Command-C)

Each group of parameters in the Inspector reveals a single, aggregated keyframe track, that holds all the keyframes of all the parameters within that group, and makes it easy to move, delete, cut, copy, and paste keyframes for each clip. For example, the Pan, Tilt, Zoom, Rotation Angle, and Anchor Point keyframes all appear within the Transform track.
If you want to edit each parameter independently, a small disclosure control at the right of each keyframe track lets you open up an aggregated keyframe track into individual keyframe tracks, one for each parameter that’s been keyframed within that group of Inspector controls.

Additionally, each keyframed clip has a Curve button that, when clicked, exposes that parameter within a Curve Editor that’s attached to the clip in the Timeline.

To expose a clip’s Curve Editor:
- Click a clip’s Curve button, at the bottom right corner of the clip.
- Choose Clip > Show Curve Editor (Shift-C).

Multiple parameters can be opened within the Curve Editor at the same time, and you can choose which curve to work on by clicking it in the Curve Editor, or clicking one of that parameter’s keyframes in the keyframe track above. Selected control points can be moved, and their Bezier interpolation changed using one of the four buttons located at the top of the Curve Editor.

Keyframing in the Video Inspector

Keyframing in the Cut and Edit pages works slightly differently than when using the Keyframe Editor in the Color page. Most simple keyframing tasks can be performed in the Inspector using three buttons that appear to the right of any parameter that’s capable of being keyframed. It takes two keyframes at minimum to create an animated effect.
Methods of keyframing parameters in the Inspector:

- **To add a keyframe:** Select a clip, open the Inspector, then move the Timeline playhead to the frame where you want to place a keyframe, and click the Keyframe button next to the parameter of the Inspector you want to animate. Once you’ve added at least one keyframe to a parameter, all other adjustments you make to parameters in the Inspector, or using the onscreen Transform/Crop controls in the Timeline Viewer add new keyframes automatically if the playhead is at another frame.

- **To move the playhead to the next or previous keyframe:** Click the small left- or right-hand arrow to either side of a parameter’s keyframe control to jump the playhead to the next or previous keyframe. You can also press Right-Bracket (]) and Left-Bracket ([) to go from keyframe to keyframe.

- **To edit an existing keyframe of a parameter:** Move the playhead to be on top of the keyframe you want to edit, and then change that parameter, either in the Inspector, or using the onscreen controls of the Timeline Viewer.

Methods of changing keyframe interpolation in the Inspector:

- **To change a keyframe to Ease In or Ease Out:** Eased keyframes create animated changes that begin slowly and accelerate to full speed, or slow down gradually to decelerate to a stop. This only works when you have two or more keyframes creating an animated effect. Move the playhead to a frame with a keyframe using the next/previous keyframe controls, then right-click the orange keyframe button and choose Ease In, Ease Out, or Ease In and Out, depending on which keyframe you’re editing and the effect you want to create.

- **To change a keyframe to Linear:** Move the playhead to a frame with a keyframe using the next/previous keyframe controls, then right-click the orange keyframe button and choose Linear.

Methods of deleting keyframes and disabling keyframed effects:

- **To delete a single keyframe:** Open the Inspector, move the Timeline playhead to a frame with a keyframe, and click the orange Keyframe button in the Inspector to delete it.

- **To delete all keyframes for one parameter:** Click the reset button to the right of a parameter’s keyframe control in the Inspector.

- **To delete all keyframes in a group of parameters in the Inspector:** Click the reset button to the right of a parameter group’s title bar in the Inspector.

- **To disable or enable a single parameter’s keyframed effect:** In the Timeline, click the toggle control at the left of a parameter’s keyframe track. White means that track’s enabled. Gray is disabled.

- **To disable or enable a group of parameters in the Inspector:** Click the toggle control at the left of a parameter group’s title bar in the Inspector. Orange means that group is enabled. Gray is disabled.
Keyframing Motion Paths in the Timeline Viewer

If you're keyframing a clip's transform controls to create motion, a motion path appears when you turn on the onscreen transform controls using the button to the left of the transport controls.

A visible motion path resulting from animated Position X and Y parameters

Each keyframed change to the Position X and Y parameters creates a control point on the surface of the motion path, which is linear by default, creating a sharp edge. However, you can right-click any control point and choose Smooth from the contextual menu to add Bezier handles to that control point, which let you change the sharp angle to an adjustable curve.

Changing the linear control point into a Bezier curve

The control points making up any motion path can be dragged around at will to change the path the selected clip will travel. Dots on the surface of the motion path indicate the velocity of motion; dots that are closer together indicate slower motion, while dots that are farther apart indicate faster motion. Dragging a motion path control point farther away from another one will speed up the animation between both points, while dragging it closer will slow the animation down, as you're setting up the selected clip to travel a longer or shorter distance within the same keyframed time.

Dots on the motion path show that the left half has slow motion, while the right half has faster motion
You can also adjust the shape of any control point's curve by clicking to select that control point, which exposes its Bezier handles, and then dragging the handles to adjust its curve. Once handles have been exposed, there are a variety of methods you can use to adjust them and manipulate the motion path.

Finally, you can adjust the acceleration of motion by adjusting the Acceleration handle on the stem of any Bezier curve. Dragging an acceleration handle towards a control point creates an eased keyframe, where motion slows to a stop, or begins from a stop. Dragging an acceleration handle away from a control point creates more linear motion, where the object moves continuously through that control point.

Methods of adjusting the Bezier handles of motion paths:

– Drag any control point to reshape the motion path.
– Drag any Bezier handle to change the shape of the curve.
– Command-drag any Bezier handle to break the tangent between it and the opposite Bezier handle. When you release the Command key, the two Bezier handles become locked together again at whatever angle you created.

To eliminate a control point on a motion path, along with its keyframe:

– Right-click any control point and choose Delete Keyframe.

To switch a control point between sharp and curved angles:

– Right-click any control point and choose Linear (for a sharp angle) or Smooth (for a curve).
Keyframing in the Edit Timeline and Curve Editor

If you need to do more complicated keyframe editing than the relatively simple controls of the Inspector allow, you can use the Keyframe tracks and Curve Editor found in the Edit Timeline. When one or more clip parameters are keyframed, two small buttons appear at the far right of a clip’s name bar in the Timeline, a Curve button and a Keyframe button. These buttons let you access specialized keyframe editors that serve different purposes.

The Keyframe Editor

The Keyframe Editor in the Timeline is the simplest way of exposing all of a clip’s keyframes and adjusting their timing and interpolation. It’s only available when you’ve already keyframed one of a clip’s Inspector properties.

To open or close the Keyframe Editor:

– Click a clip’s Keyframe button at the far right of a clip’s name bar.
– Select a clip and choose Clip > Show Keyframe Editor (Command-Shift-C).

The Keyframe Editor exposes one keyframe track for each group of parameters that’s keyframed. For example, the Composite parameters, Transform parameters, and Cropping parameters are all encapsulated by group tracks. For example, if you’d added keyframes to the Zoom and Position parameters, these keyframes all appear within a single keyframe track labeled Transform, while Opacity adjustments appear on a second keyframe track for Composite.

However, each group keyframe track has a disclosure button that lets you show or hide each individual parameter that’s keyframed within that group. For example, clicking the Transform keyframe track’s disclosure button shows the Zoom and Position tracks, so you can adjust those individual keyframes.
Individual parameter keyframe tracks open in the Timeline

These keyframe tracks let you edit keyframes in context of the actual clip durations in the Timeline. Click the small Keyframe button at the bottom right of the clip’s name bar to close the keyframe tracks when you’re finished.

Methods of adding and selecting keyframes in the Keyframe Editor of the Edit page:

– To add new keyframes to the Keyframe Editor: Option-click anywhere on a track of the Keyframe Editor to add a new keyframe, which defaults to whatever the current value is for that parameter at that frame. New keyframes create linear animated changes by default.

– To duplicate one or more keyframes: Make a selection of keyframes, then hold the Option key down and drag the selected keyframes to duplicate them and move the duplicates to a new position.

– To select a single keyframe: Click a single keyframe to select it.

– To select multiple discontiguous keyframes: Command-click all keyframes you want to select, whether they’re next to one another or not.

– To select multiple contiguous keyframes: Click the first keyframe you want to select, and then shift-click the last keyframe you want to select, and all keyframes between will also be selected, or drag a bounding box within the keyframe track around multiple keyframes to select them all at once.

Methods of changing keyframe interpolation/easing/smoothing in the Keyframe Editor of the Edit page:

– To change one or more Linear keyframe to Ease In or Ease Out: Eased keyframes create animated changes that begin slowly and accelerate to full speed, or slow down gradually to decelerate to a stop. This only works when you have two or more keyframes creating an animated effect. Select one or more keyframes, then right-click one of the selected keyframes and choose Ease In, Ease Out, or Ease In and Out, depending on which keyframe you’re editing and the effect you want to create.

– To change one or more eased keyframes to Linear: Select one or more keyframes, then right-click one of the selected keyframes and choose Linear.

Methods of moving and adjusting keyframes in the Keyframe Editor of the Edit page:

– To move one or more keyframes: Select one or more keyframes and drag left or right. While you drag keyframes, a tooltip appears showing you the offset in frames of your adjustment from the beginning of that clip’s source media. If you’re only dragging one keyframe, the tooltip also shows you the name of the parameter you’re modifying.

– To nudge selected keyframes one frame at a time: Select one or more keyframes and press Command-Left Arrow or Command-Right Arrow to nudge them back and forth, for precision editing. The Curve Editor must also be open.
Methods of Cutting, Copying, Pasting, and Deleting keyframes:

– **To cut or copy, and paste one or more keyframes**: Make a selection of keyframes, and use the Cut (Command-X) or Copy (Command-C) key shortcuts. Then, move the playhead to where you want the first of the copied keyframes to start, and press Paste (Command-V). The Curve Editor must also be open.

– **To delete one or more control points from a curve**: Select the keyframe(s) you want to delete and press Backspace. The Curve Editor must also be open.

**The Curve Editor**

If you want to work with keyframes in even more detail, you can use the Curve Editor. The Curve Editor can be opened in addition to the Keyframe Editor, or it can be opened in isolation. When clicked, the Timeline expands to accommodate a large space under an animated clip in which you can freely adjust both the timing and value of selected keyframes, while also providing optional bezier spline controls used to create smooth curves with which to adjust the acceleration of animated changes from one value to another.

**To open or close the Curve Editor:**

– Click a clip’s Curve button at the far right of a clip’s name bar.

– Select a clip and choose Clip > Show Curve Editor (Shift-C).

You can open multiple parameters into the Curve Editor using the curve pop-up menu at the upper left-hand corner of the Curve Editor that lets you choose which parameters are exposed via checkboxes. This menu also lets you choose which curve is selected by clicking the name of the parameter you want to edit.
Choosing which parameters to display in the Curve Editor

While you can only work on one curve at a time, you can choose which is selected for editing by either selecting it in this pop-up menu or by clicking any dimmed curve in the Curve Editor. Using the control points exposed by each curve, you can edit parameters, alter keyframe timing, and change each control point’s interpolation to create custom easing effects affecting the acceleration of change from one keyframe to the next.

Methods of adding and selecting keyframes in the Curve Editor of the Edit page:

- **To change which curve you’re editing:** If the Keyframe Editor is open at the same time as the Curve Editor, you can click the keyframe track you want to edit and the corresponding curve will be highlighted. Otherwise, click the Curve menu at the upper left-hand corner of the Curve Editor, and choose which curves you want to expose to work on. If multiple curves are open in the Curve Editor, click any dimmed curve in the background to highlight it for editing. If the clip you’re editing is too narrow, then the Curve menu may be hidden; zooming into the Timeline will show the Curve menu again.

- **To add new keyframes to a curve:** Option-click anywhere on a curve to add a new control point.

- **To duplicate one or more keyframes:** Make a selection of keyframes, then hold the Option key down and drag the selected keyframes to duplicate them and move the duplicates to a new position (and even new values). This can be a good way to quickly loop a repetitive animated effect you’ve created.

- **To select a single keyframe:** Click a single keyframe to select it.

- **To select multiple discontiguous keyframes:** Command-click all keyframes you want to select, whether they’re next to one another or not.
– **To select multiple contiguous keyframes**: Click the first keyframe you want to select, and then shift-click the last keyframe you want to select, and all keyframes between will also be selected, or drag a bounding box within the Curve Editor around multiple keyframes to select them all at once.

– **To select all keyframes**: If the Keyframe Editor is open and it has focus (by clicking anywhere within it), then pressing Command-A will select all keyframes within that Keyframe Editor.

### Methods of adjusting keyframes in the Curve Editor of the Edit page:

– **To drag one or more keyframes freely on a curve**: Select one or more keyframes and drag left or right to retime them, and up or down to change their value.

– **To drag one or more keyframes on a curve in only one direction**: Select one or more keyframes, then hold the Shift key while dragging either vertically or horizontally to constrain keyframe adjustment within that single direction.

– **To nudge selected keyframes one value or frame at a time**: Select one or more keyframes and Command-Left Arrow and Command-Right Arrow to nudge them in time, or Command-Up Arrow and Command-Down Arrow to nudge their value, for precision keyframe adjustments.

### Methods of changing keyframe interpolation/easing/smoothing:

– **To change the interpolation of a single keyframe**: There are two methods. You can select the keyframes you want to change, and then click one of the four Bezier interpolation buttons in the Curve Editor title bar. Or, you can right-click one of the selected keyframes and choose one of the interpolation options from the contextual menu. Keyframes that have already been eased in the Keyframe Editor or via controls in the Inspector already have bezier handles exposed in the Curve Editor.

– **To change the interpolation of multiple keyframes**: Select multiple keyframes by Command-clicking or dragging a bounding box, and then click one of the four Bezier interpolation buttons in the Curve Editor title bar to simultaneously change the interpolation of all of them.

– **To adjust a Bezier handle**: Drag the Bezier handle in any direction to alter the curve.

### Methods of Cutting, Copying, Pasting, and Deleting keyframes:

– **To cut or copy, and paste one or more keyframes**: Make a selection of keyframes and use the Cut (Command-X) or Copy (Command-C) key shortcuts. Then, move the playhead to where you want the first of the copied keyframes to start, and press Paste (Command-V).

– **To delete one or more control points from a curve**: Select the keyframe(s) you want to delete and press Backspace.
Keyframable Open FX and Resolve FX

The parameters of Open FX and Resolve FX have keyframe controls to the right of each parameter's number field in the Effects Inspector of the Edit and Color pages, so you can animate effects that you add to clips and grades.

Resolve FX can now be animated in the Edit page using keyframe controls in the Inspector.

Additionally, keyframes added to Resolve FX parameters in the Inspector now appear in both the Keyframe and Curve Editor of the Edit page Timeline. You can expose individual keyframe tracks and curves for each keyframed parameter of an effect applied to a clip, for smoothing, retiming, or editing.
Chapter 55

VFX Connect

For instances where the various effects of the Edit, Fusion, and Color page aren’t enough to achieve the effect you require, you can use the VFX Connect feature of DaVinci Resolve to send one or more clips from the Edit page timeline to the standalone version of Blackmagic Fusion, in order to do more robust compositing and effects work there. You can use this workflow in the macOS, Windows, and Linux versions of DaVinci Resolve, since Fusion works on all three platforms. This is a simple round-trip operation that lets you send clips from the DaVinci Resolve Timeline to Fusion, add effects, and then render a finished effect out of Fusion that will automatically appear back in your timeline.

Contents

Using VFX Connect ............................................. 915
How Clips are translated into Node Trees .............. 917
Altering VFX Connect Clips .................................. 918
Creating Multiple Versions of Fusion Clips .......... 918
Switching Versions of VFX Connect Clips in DaVinci Resolve .......... 919
Sending a VFX Connect Directory to Another Machine ...... 919
Creating Multiple Versions of Fusion Clips on Another Machine .... 920
Updating VFX Connect Clips Using Render Media and Refresh .... 920
Using VFX Connect

Sending one or more clips to the standalone version of Blackmagic Fusion is simple.

To send clips to Fusion:

1. Select one or more clips in the Timeline that you want to send to Fusion. In this example, two superimposed clips are selected.

2. Right-click one of the selected clips and choose New VFX Connect Clip from the contextual menu.

3. In the New VFX Connect Clip dialog, choose the following options:
   a. Enter a name.
   b. Choose a video format (for rendering media to send to Fusion).
   c. Choose a codec, based on the format you selected.
   d. If you want to send Alpha channels to Fusion, turn the Export Alpha checkbox on. This exports alpha channels that are embedded in a clip, as well as alpha channels that are being created in DaVinci Resolve.
   e. If you want to save the VFX Connect Clip that you’re creating, along with its directory and media, to a specific location, turn on the Custom Location checkbox, then click the Browse button and choose a location. Otherwise, the directory containing the VFX Connect clip and any source media rendered along with it is placed in the same directory as the scratch disk.
   f. If you want to immediately open Fusion, turn on the “Open VFX Connect Clip” checkbox. If you do this, then DaVinci Resolve by default renders each of the video clips you selected, along with every speed effect, transform, and Color page operation that’s been applied to each clip, using the Timeline Color Space. However, if you click Cancel when the Render Composition Media dialog appears, then the Fusion project that opens references the source media on disk, rather than rendered media that’s generated by DaVinci Resolve.
When you’re finished, click Create. DaVinci Resolve creates a VFX Connect clip, which appears in the Timeline as a single clip and in the Media Pool.

Opening the VFX Connect clip in Fusion can be done in one of two ways:

- If you turned on “Open VFX Connect Clip,” then Fusion automatically opens and the clips you selected appear as Loader nodes within Fusion.

- If you didn’t, then you can right-click the VFX Connect clip in the Media Pool, and choose VFX Connect > Open Fusion from the contextual menu.

At this point, new media is rendered (by default), Fusion opens, and the clips you sent are converted into a Fusion node tree, explained in greater detail in the following section.

In Fusion, use the available tools to create the required effect.

Optionally, before you render, if you want to change the Output Format, click the Output node, and choose a new format from the Output Format pop-up in the Tools tab. If you don’t do this, the Fusion composite will be rendered using the format you selected when you sent the VFX Connect clip in the first place.
When you're finished creating your effect in Fusion, click the Render button to open the Render Settings, check to make sure that the settings are correct, and click Start Render. This renders the Fusion composition to the disk location and using the name that you chose in step 3.

A Render Settings dialog appears, which lets you choose how you want to render the output, with options including the Quality, Frame Range, and Size of the media being output. If the default settings are good, click Start Render. A progress bar indicates how long the render will take. For more information, consult the Fusion User Manual.

Once rendering has finished, save your Fusion project, reopen DaVinci Resolve, and you should see that the VFX Connect clip in the Timeline has updated to show the new effect you created in Fusion.

How Clips are translated into Node Trees

In Fusion, each clip that you send appears as a Loader node that is linked to that clip's media on disk. If you selected multiple clips, each clip is superimposed over the one just below it using a Merge node, which lets you merge two images at a time with an Over operator by default.
With this as your starting point, you can add nodes (called Tools in Fusion) to apply operations of your own, in order to create more sophisticated effects and composites. For more information about using Fusion, see the Fusion User Manual, available from the Support page at the Blackmagic Design web site.

**Altering VFX Connect Clips**

If, at any point, you want to modify the Fusion composition, you can reopen the project in Fusion, or right-click the VFX Connect clip in the DaVinci Resolve Media Pool and choose VFX Connect > Open in Fusion. Once in Fusion, make whatever changes you want to, and then re-render the clip to overwrite the previously rendered media. When you create new versions in this way, each version’s Fusion project file and rendered output is maintained and preserved, so you can always go back and forth.

When you return to DaVinci Resolve, you may need to right-click the VFX Connect clip you just opened, and choose VFX Connect > Refresh to make sure that DaVinci Resolve correctly sees the re-rendered media from Fusion.

**Creating Multiple Versions of Fusion Clips**

If you want to render a new version, but you want to keep the previous version, then you can right-click the VFX Connect clip in the Resolve Media Pool and choose VFX Connect > Create New Version.

This creates a duplicate of the composite in Fusion, with the “_v1” part of the filename incremented so it doesn’t overwrite the previous version of that composite.

Once in Fusion, make whatever changes you need to the composite, then re-render the clip to generate an additional piece of media for that version. The filename of the Saver node for the new media you’re rendering is also automatically incremented with the “_v1” segment of the filename changed to the next version number, such as “_v2” if it’s version two of the effect.

The Tools panel shows the Saver node’s updated filename for the new version’s rendered output.
When you're finished, you'll end up with a Fusion Project file and a corresponding rendered media file that share the same version number. When you return to DaVinci Resolve, Resolve will automatically detect that there are multiple versions in the VFX Connect directory, and will make each version available via a Choose Version submenu for VFX Connect clips in the Media Pool.

**Switching Versions of VFX Connect Clips in DaVinci Resolve**

Once you've created multiple versions of a VFX Connect clip, you can switch which version is used for that clip in DaVinci Resolve by right-clicking the VFX Connect clip in the Media Pool, and choosing the version from the VFX Connect > Select Version submenu of the contextual menu.

![Choosing which version to use from the VFX Connect > Select Version submenu](image)

**TIP:** If you want to switch versions for a VFX Connect clip in a timeline, you can right-click that clip and choose Find in Media Pool.

**Sending a VFX Connect Directory to Another Machine**

If you're going to hand off a VFX Connect directory to someone else using a different workstation, it's a good idea to render self-contained media for the Fusion composition to make it easy to hand off everything the compositing artist will need. Otherwise, you'll need to manually find and provide the associated media files yourself. There are two ways of rendering self-contained media for Fusion:

- If you check "Open VFX Connect Clip" in the New VFX Connect Clip dialog, then DaVinci Resolve by default renders each of the video clips you selected, along with every speed effect, transform, and Color page operation that's been applied to each clip, using the Timeline Color Space.
- If you haven't opened the VFX Connect clip in Fusion yet, you can also right-click any VFX Connect clip in the Media Pool, and choose VFX Connect > Render Media from the contextual menu.

Once that's done, there are two ways you can locate the actual VFX Connect directory's location, in order to copy it for whomever is going to be doing the compositing work for you:

- You can turn on the Custom Location checkbox in the New VFX Connect Clip dialog, then click the Browse button and choose a location where the resulting directory is easily copied.
- You can also right-click on any VFX Connect clip in the Media Pool, and choose Reveal in Finder to open that VFX Connect clip's directory.

Since your DaVinci Resolve project keeps track of the location of the VFX Connect directory from the moment it's created, you don't want to move it, since DaVinci Resolve is counting on it being where it thinks it is. Once your colleague has completed the compositing work in Fusion, all they need to do is
send you back the Fusion Composition file (just so you can keep everything together), and the media they rendered, both of which you need only copy to the top level of the corresponding VFX Connect directory. Once you do that, DaVinci Resolve should automatically see the rendered media and refresh those VFX Connect clips on your timeline.

**Creating Multiple Versions of Fusion Clips on Another Machine**

If you’ve handed off the directory created by the VFX Connect process to someone off site, they can still create multiple versions of the composite that can be managed by DaVinci Resolve.

Use the Save As command in Fusion to save a duplicate of the Fusion project with the "_v1" segment of the filename incremented to the next version number, such as "_v2" if it’s version two of the composite. Make sure you save this duplicate Fusion project into the same directory as the original, so DaVinci Resolve can find it. Once created, you can change this duplicate project file any way you need.

When you’re finished, select the Saver node (at the very end of the Fusion node tree), and change the filename by incrementing the V1 part of the Filename field. For example, if your clip is being named Output_V1.mov, then change the filename to Output_V2.mov in the Tools tab, and render. If you’re rendering a DPX image sequence, then you’ll want to change the name of the folder that encloses the frames, so change the filename from "/fusion/OutputDirectory_V1/Output_00000000.dpx" to "/fusion/OutputDirectory_V2/ Output_00000000.dpx" to obtain a correctly named second version.

**Updating VFX Connect Clips Using Render Media and Refresh**

If you change a grade or effect that’s applied to a clip inside of a VFX Connect clip, you’ll need to right-click that clip and choose VFX Connect > Render Media to re-render updated media files for the Fusion project.

If you re-render a Fusion composite and overwrite media that’s already referenced by a VFX Connect clip in an open DaVinci Resolve project, you may need to refresh that media reference in DaVinci Resolve. The easy way to do this is to right-click any VFX Connect clip in the Media Pool, and choose VFX Connect > Refresh.
Import and Conform Projects

PART 7
Chapter 56

Preparing Timelines for Import and Comparison

Generally speaking, “conforming” a project describes the process of importing a project exchange file from another post-production application, and automatically relinking each clip in the imported timeline to the high-quality media files each clip corresponds to.

If you need to continue editing, color correct, or finish a project that was put together in another application, you can import via the EDL, AAF, or XML project exchange formats. When you go through the process of conforming a project, you use the imported project data to arrange the clips in the Media Pool into a timeline that constitutes the program that’s about to be graded.

This chapter walks you through the process of preparing timelines in other applications prior to moving them into DaVinci Resolve and covers which effects have counterparts in the DaVinci Resolve timeline. It ends with instructions on how to set up to compare a reference movie to the Timeline.

Contents

Preparing to Move Your Project to DaVinci Resolve 923
Move Clips to the Lowest Video Track 923
Organize Unsupported Media Files 924
Creating an Offline Reference Movie 924
Mixed Frame Sizes and Mixed Codecs 924
Mixed Frame Rates 924
Preparing to Move Your Project to DaVinci Resolve

When you’re preparing to move a project from another NLE to DaVinci Resolve, there are a few steps you can take to make your work more organized.

**Move Clips to the Lowest Video Track**

Editors often use the multiple tracks NLEs offer for simple clip organization in the edit of a scene. While this is convenient for offline editorial, it is less convenient when you’re trying to conform, grade, finish, and render the media used by a project as quickly and efficiently as possible.

For this reason, it’s a good idea to move all clips that are not stacked or superimposed as part of a compositing operation down to track V1 of the Timeline in your NLE. This produces a simplified edit that has many advantages. The project becomes smaller to move because there’s less media in the Timeline, and consequently becomes faster to render. Furthermore, the colorist is spared confusion because this eliminates “hidden” media that is nonetheless connected to other clips that can be seen.

It’s also helpful, once you’ve reorganized the Timeline, to eliminate any empty tracks that are left. This can be done from within DaVinci Resolve, but doing it in your NLE further simplifies the project import process.
Organize Unsupported Media Files

Depending on your workflow and on the NLE you’re working with, there may be clips using formats that are unsupported in DaVinci Resolve. Unsupported generators, media formats, and other effects constructs may simply not be seen in DaVinci Resolve, and will consequently appear as unlinked clips.

If you know this in advance, you can move all such clips into dedicated tracks where they can be isolated, and the track can be turned off to hide the unsupported clips, simplifying timeline navigation. This also saves the colorist from the need to worry about why there are offline clips in the Timeline at 3 o’clock in the morning, immediately before starting a render.

Creating an Offline Reference Movie

Even though the colorist in any given workflow is likely to be building new grades from scratch, it can be valuable to have a reference movie showing any color corrections, filters, or effects that the offline editor applied during the editing process. This offline reference can be imported into a DaVinci Resolve project, and used as a split-screen reference whenever there’s some question about a look or effect from the offline edit.

Offline reference movies also serve as a useful tool when conforming a project in the Edit page. After project conform, you can compare the project as seen in the Record Viewer with the synchronized offline movie as seen in the Source Viewer set to Offline mode. This makes it easy to scrub through a project to make sure that each clip has imported correctly and is in sync.

More information about using offline reference movies appears later in this chapter.

Mixed Frame Sizes and Mixed Codecs

Most NLEs can freely mix media using different frame sizes, different codecs, and different frame rates. DaVinci Resolve deals with these combinations in different ways, depending on what settings you’ve selected in the Project Settings.

– **Mixing Frame Sizes**: Mixed frame sizes are easily handled. The Set Timeline Resolution To parameter in the Project Settings panel of the Project Settings dictates the current resolution of the project. Any clips with a frame size that doesn’t match the project is resized according to the option selected in the Image Scaling panel of the Project Settings. You can, of course, always manually readjust the sizing of any clip if you want to make a specific adjustment. All resizing is done using the optical-quality resizing algorithms in DaVinci Resolve. For more information, see Chapter 150, “Sizing and Image Stabilization.”

– **Mixing Codecs**: Mixed codecs are also not a problem, as long as the different codecs used by the media in the project you’re importing are compatible with the list of codecs and formats that DaVinci Resolve supports. For more information about the currently supported list of codecs and formats, check the Blackmagic Design support page for DaVinci Resolve. This list is updated often with newly supported formats.

Mixed Frame Rates

DaVinci Resolve also supports mixed frame rates, although there is a setting you must choose to ensure the best results for the NLE you’re importing from. By default, mixed clip frame rate support is enabled via the “Mixed frame rate format” pop-up menu that appears either in the Master Project Settings, or in the Import AAF or XML dialog.

The different options available in the “Mixed frame rate format” pop-up are available to let you conform projects using the method of mixed frame rate calculation used by the NLE a project was originally edited in; different NLEs have different ways of mixing frame rates, and that used by Final Cut Pro 7 is different from that used by Final Cut Pro X or Avid Media Composer. If you need to change this setting, you must do so before you import any media into the Media Pool; once the Media Pool is populated, this setting can no longer be changed.
This Mixed frame rate format pop-up menu is also found in the Load AAF and Load XML dialogs. DaVinci Resolve automatically chooses a setting from the “Mixed frame rate format” pop-up menu that corresponds to the project file you’re importing, but in some cases you can override this setting if necessary. For projects sent from Final Cut Pro, you can choose either “Final Cut Pro 7” or “Final Cut Pro X” to match the type of project you’re importing. On the other hand, you should choose “Resolve” for projects imported from Premiere Pro, Smoke, Media Composer, or other NLEs.

When “Mixed frame rate format” is set to anything but None, DaVinci Resolve conforms and processes all clips in the Timeline to play at the project’s frame rate. For example, 23.98, 29.97, 30, 50, 59.94, and 60 fps clips will all play at 24 fps if that’s what “Timeline frame rate” is set to in the Master Project Settings. Clips with different source frame rates will be retimed to match the Timeline conform frame rate.

The Retime process that’s used to render clips with differing frame rates can be changed for individual clips via the Retime Process parameter in the Edit page Inspector, or it can be changed project-wide using the Retime Process parameter found in the Frame Interpolation panel of the Master Project Settings. For more information on how each of the three available options work, see the “Frame Interpolation” section of Chapter 4, “System and User Preferences.”

If you choose “None,” then clips with frame rates that aren’t equal to the Timeline frame rate will ignore their original frame rate and will play at the Timeline rate, resulting in either faster or slower motion, depending on the difference between the original and Timeline frame rates.

**NOTE:** Because DPX files often either lack or have incorrect frame rate information in the header data, you may need to select None when conforming a project using image sequences to make sure your media is not incorrectly interpreted.

How clips in mixed frame rate timelines are rendered depends on whether the Render Settings are set to render individual source clips or one single clip. When you render the Timeline as "Individual Source Clips," then all clips are rendered individually at their original frame rate. If you select "Single Clip," then all clips are converted to the "Timeline frame rate" frame rate setting, and rendered as a single media file.
**Importing Effects when Conforming Edits**

DaVinci Resolve is capable of translating a subset of the effects exported within XML, AAF, and EDL project files into their DaVinci Resolve equivalents. The following chart illustrates which effects are supported, and for which project import formats.

Unsupported effects are neither imported nor displayed in DaVinci Resolve. However, the majority of unsupported effects are preserved internally, and are reinserted into exported XML or AAF files so that those effects will reappear in your NLE once the project is reimported.

<table>
<thead>
<tr>
<th></th>
<th>EDL</th>
<th>FCP 7 XML</th>
<th>FCP X XML</th>
<th>AAF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color Corrections</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Composite Modes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Overlay only</td>
</tr>
<tr>
<td>Multiple Tracks</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Video Transitions</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Audio Transitions</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Opacity Settings</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes, via 3D Warp or Superimpose</td>
</tr>
<tr>
<td>Position, Scale, Rotation</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes, via 3D Warp</td>
</tr>
<tr>
<td>Flip and Flop</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes, via Flip, Flop, or Flip-Flop effects</td>
</tr>
<tr>
<td>Pitch and Yaw</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes, via 3D Warp</td>
</tr>
<tr>
<td>Linear Speed Effects</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Variable Speed Effects</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Still Image Clips</td>
<td>No</td>
<td>All supported formats in Resolve</td>
<td>All supported formats in Resolve</td>
<td>All supported formats in Resolve</td>
</tr>
<tr>
<td>Freeze Frames</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Nested Sequences</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Linked Clip Audio</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Mixed Frame Rates</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Text Generators</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Effects supported with imported AAF, XML, and EDL

**About Supported Color Corrections**

At the time of this writing, only Final Cut Pro X XML projects are capable of exporting color correction data that can be imported as primary grades in DaVinci Resolve. For obvious reasons, color correction import is a one-way street, and imported color corrections cannot be output back to Final Cut Pro. Imported Final Cut Pro X color adjustments appear in the Color page as primary corrections.

Other workflows for importing color correction information from other applications are available using ColorTrace to import grade data from CDLs (Color Decision Lists). For more information, see the “Copying Grades Using ColorTrace” section in Chapter 146, “Copying and Importing Grades Using ColorTrace.”
About Supported Transitions

EDLs are the most restrictive when it comes to transition support in DaVinci Resolve, as only Cross Dissolves will be read. Any other transitions appearing in an EDL will be automatically converted to a Cross Dissolve of the same duration when it’s imported into DaVinci Resolve.

On the other hand, DaVinci Resolve supports the import of ten different transitions when importing XML project files from Final Cut Pro X and legacy Final Cut Pro 7, or nine different transitions when importing AAF files from Avid Media Composer or Symphony.

<table>
<thead>
<tr>
<th>Transition Name</th>
<th>EDL</th>
<th>FCP XML</th>
<th>AAF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clock Wipe</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Center Wipe</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Cross Dissolve</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Additive Dissolve</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Dip to Color Dissolve</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Edge Wipe</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Venetian Blind Wipe</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Cross Iris</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Diamond Iris</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Oval Iris</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Supported transitions for imported EDL, XML, and AAF

Transition Names

To help you prepare projects for export, note that the names of transitions vary between XML and AAF project files. Here are the supported transitions as they appear in Avid Media Composer and Symphony.

<table>
<thead>
<tr>
<th>Transition Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dip to Color Dissolve</td>
<td>Dip to Color effect in the Blend category</td>
</tr>
<tr>
<td>Edge Wipe</td>
<td>Horizontal/Vertical/Lower Left/Lower Right/Upper Left/Upper Right Diagonal effects in the Edge Wipe category</td>
</tr>
<tr>
<td>Center Wipe</td>
<td>Horizontal Open and Vertical Open effects in the Edge Wipe category</td>
</tr>
<tr>
<td>Clock Wipe</td>
<td>Clock effect in the Shape Wipe category</td>
</tr>
<tr>
<td>Venetian Blind Wipe</td>
<td>Vertical Blinds and Horizontal Blinds effects in the Shape Wipe category</td>
</tr>
<tr>
<td>Cross Iris</td>
<td>4 Corners effect in the Shape Wipe category</td>
</tr>
<tr>
<td>Diamond Iris</td>
<td>Diamond effect in the Shape Wipe category</td>
</tr>
<tr>
<td>Oval Iris</td>
<td>Circle effect in the Shape Wipe category</td>
</tr>
</tbody>
</table>
About Supported Opacity, Position, Scale, and Rotation Settings

When importing XML project files from Final Cut Pro X, Premiere Pro, or legacy Final Cut Pro 7, DaVinci Resolve supports the import of Opacity, Position, Scale, and Rotation settings. Imported Composite and Transform settings for any given clip appear in the Inspector of the Edit page, or in the Edit Sizing mode of the Sizing palette in the Color page. If these settings have been keyframed, the animation will appear in DaVinci Resolve.

When importing AAF files from Media Composer or Symphony, DaVinci Resolve supports the import of Opacity, Resize, and 3D Warp effects, which are converted into Pan, Tilt, Zoom, and Rotate settings in DaVinci Resolve, located in the Edit page Inspector or the Edit Sizing mode of the Sizing palette in the Color page.

About Flip and Flop Support

When importing AAF project files from Media Composer or Symphony, Flip, Flop, and Flip-Flop effects are converted into the equivalent horizontal and vertical Flip toggles in DaVinci Resolve, located in the Edit page Inspector or the Edit Sizing mode of the Sizing palette in the Color page.

Pitch and Yaw

When importing AAF files from Media Composer or Symphony, DaVinci Resolve supports the import of Pitch and Yaw 3D Warp effects, which are converted into equivalent Pitch and Yaw settings in DaVinci Resolve, located in the Edit page Inspector or the Edit Sizing mode of the Sizing palette in the Color page.

About “Ken Burns Effect” and Dynamic Zoom

If you import a project from Final Cut Pro X with clips that use the Ken Burns effect for creating pan and scan animation, then the Dynamic Zoom parameters (found in the Edit page Inspector when a clip is selected) for each affected clip will be populated with an equivalent animated effect.

About Speed Effects

DaVinci Resolve supports the import of speed effects from different applications, but different project formats have different speed effect support.

- **EDL**: DaVinci Resolve only supports the import of linear speed effects when importing EDLs.
- **XML**: DaVinci Resolve supports the import of both linear and variable speed effects when importing XML project files from Premiere Pro, Final Cut Pro 7, and Final Cut Pro X. As of DaVinci Resolve version 11.1, XML from Final Cut Pro X can also provide information about whether frame blending or optical flow is used, as well as information about the Bezier curve transitions of speed effects.
- **AAF**: DaVinci Resolve supports the import of both linear and variable speed effects when importing AAF files from Media Composer or Symphony that use Timewarp effects.

DaVinci Resolve has high-fidelity conversion of variable-speed speed effect data from other applications, accomplished by creating one speed keyframe per frame for each affected clip. However, you may see small variations between the resulting speed effect in DaVinci Resolve and an offline reference movie exported from the original NLE if you haven’t set the Retime Process setting to the same type of speed interpolation that the original NLE was using.

In other words, if you created a Timewarp speed effect in Media Composer that uses FluidMotion to create smooth slow motion effects, then you’ll want to make sure to change either the project-wide or clip-specific Retime Process setting to Optical Flow so that the speed effects in DaVinci Resolve best match those in Media Composer. For more information on speed effects in DaVinci Resolve, see Chapter 52, “Speed Effects.”
About Nested Sequences and Compound Clips

DaVinci Resolve supports the import of compound clips from Final Cut Pro X and of nested sequences from legacy Final Cut Pro 7. Both appear within DaVinci Resolve as compound clips, in both the Timeline and the Media Pool. Compound clips with mixed frame rates are supported, as well as multi-cam and A/V synchronized clips from Final Cut Pro X, which are represented in DaVinci Resolve as compound clips. For more information about creating and using compound clips in DaVinci Resolve, see the “Compound Clips” section of Chapter 43, “Take Selectors, Compound Clips, and Nested Timelines.”

About Supported Composite Modes

When importing XML project files from Final Cut Pro 7, Premiere Pro, and Final Cut Pro X, DaVinci Resolve supports the import of eight different composite modes. When importing AAF files from Media Composer, the Overlay composite mode is supported when the source AAF file has a Superimpose effect applied to it.

<table>
<thead>
<tr>
<th></th>
<th>FCP 7/X XML</th>
<th>AAF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Subtract</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Difference</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Multiply</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Screen</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Overlay</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Lighten</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Hardlight</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Softlight</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Darken</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Supported composite modes with imported XML and AAF

About Supported Still Image Formats

DaVinci Resolve supports the import of greater-than-one-frame-in-duration TIF, JPG, PNG, DPX, TGA, and DNG still image files that appear in Final Cut Pro X, Final Cut Pro 7, and Premiere Pro XML files, and AAF files exported from Media Composer. These clips appear as ordinary clips in the DaVinci Resolve Timeline. Export of still images is limited to Final Cut Pro 7 and Final Cut Pro X XML formats.

About Supported Alpha Channels

Media with embedded alpha channels is supported for any project as long as it’s in a media format that DaVinci Resolve supports; this includes TIFF, OpenEXR image sequence formats, and four-channel QuickTime formats such as ProRes 4444, DNxHR 444, and QuickTime Animation. Alpha channels are automatically enabled, and can be used for compositing directly within the DaVinci Resolve Timeline.

Alpha channels can be exported in round-trip workflows when rendering individual source clips. However, when rendering a program as a single clip, all composited effects are rendered together to produce a single output media file. For more information on rendering clips with alpha channels, see Chapter 184, “Delivery Effects Processing.”
About Imported Text Effects

DaVinci Resolve supports the import of text generators when importing XML project files from both Final Cut Pro X and Final Cut Pro 7. All imported text effects appear in the DaVinci Resolve Timeline as Basic text generators. Some, but not all, formatting parameters are imported, depending on the project file format being imported.

About Imported Audio in AAF Projects

Any combination of audio track types, channel map order, MXF and QuickTime files, and rendered or unrendered clips should import without problems.

**NOTE:** When exporting an AAF project, DaVinci Resolve is capable of writing mono media in stereo tracks.

Preparing Unsupported Clips and Effects You Want to Grade

If there is an unsupported effect within your NLE of choice that you want to move into DaVinci Resolve for grading (for example, clips with effects filters that are native to a particular NLE), here’s a simple workflow to follow.

**To “bake” an effect into a clip you’re sending to DaVinci Resolve:**

1. Export that clip as a self-contained media file using whatever DaVinci Resolve-compatible mastering codec you prefer.
2. Reimport the resulting media file into your project.
3. Edit it into your project’s timeline to replace the original effects clip.
4. Export a version of the resulting sequence for use in DaVinci Resolve.

This is a good way of prepping the titles and effects of projects that you want to finish in DaVinci Resolve. If you create self-contained media files for all title clips and effects, then these elements will import cleanly and easily, and you can export a complete, texted version of your program out of DaVinci Resolve.

Additionally, if a composited clip is using unsupported effects (for example, a filtered still image with animated position that’s superimposed using the Overlay composite mode and set to 70% opacity), an ideal way to prep this clip for XML export to DaVinci Resolve is to set the composite mode to Normal, set Opacity to 100%, and then export the resulting clip as a self-contained QuickTime movie. Reimport the result, edit it back into the Timeline to replace the original superimposed clip, and then set its composite mode to Overlay and its Opacity to 70% to match the original settings. Now the unsupported effects are “baked” into the clip, but the effects that DaVinci Resolve does support are still live, and can be readjusted in context while grading.
Verifying Imported Timelines
Using Offline References

DaVinci Resolve has a specific interface for comparing two versions of a program. This eliminates the need to edit a rendered version of a timeline as a superimposed clip within your timeline and provides many other features to aid this comparison without cluttering your timeline.

By setting the Source Viewer in the Edit page to Offline mode, you can compare an Offline Reference Clip or Timeline to a currently open timeline, with both playheads ganged together, either side by side, or as a split screen, a box wipe, or difference operation, all of which will be visible via your video output device. As you play the Timeline, the Offline Reference Clip or timeline plays as well, making it easy to spot differences between the two.

IMPORTANT

You need to make sure that the media you’ve imported or are using as an Offline Reference Clip has a valid timecode track with a start time that matches the timecode of the Timeline you’re comparing to, otherwise there will be an offset between the Timeline and offline reference that will make a comparison difficult to impossible. Small offsets can be corrected via an offset field in the Source Viewer while in offline mode, but large offsets will be impractical to correct.

Why Set Up An Offline Comparison?

However you set up an offline reference, this is a convenient way of comparing two versions of a program. There are several reasons for comparing an Offline Reference Clip to a timeline:

– **Verifying the clip order**: If you’re unsure whether or not you’ve properly resolved reel conflicts or other problems that occurred while you were conforming a timeline, you can compare each edit to the offline version of the program to spot problems and identify the proper media that should correspond to any clip.

– **Recreating effects**: If there are offline effects, such as temporary grades made in the NLE, or pan and scan transforms that you want to check, the Offline reference mode lets you split-screen your current grade against the Offline Reference Clip in the Color page.

– **Comparing two versions of a timeline**: You can make a visual comparison a timeline with another version of that timeline to spot differences for evaluation.

– **Filling holes in timelines with missing or unlinked clips**: Two options found in the Master Project Settings panel of the Project Settings, “Show offline clips through conform gaps,” and “Show offline clips through missing clips,” let you set DaVinci Resolve to display Offline Reference Clip media to fill gaps in the Timeline or replace the contents of unlinked clips. This is typically done to resolve emergency situations when you need to proceed with a screening or review session despite the fact that you’re missing media for whatever reason. For more information, see Chapter 4, “System and User Preferences.”

**NOTE**: Typically, the flattened version of the program you’re given uses a low-quality codec, and contains effects and color correction that’s not final, which is why it’s called an Offline Reference Clip.
Assigning a Clip or Timeline for Offline Comparison

There are two ways you can assign an Offline Reference Clip or Timeline to a particular timeline for comparison. The easiest and most flexible way is to open a timeline, and then drag and drop a clip or timeline with matching timecode that you want to compare to from the Media Pool onto the Source Viewer in Offline mode.

To assign any clip or timeline to a specific timeline for comparison:

1. Open the timeline you want to make the assignment to in the Edit page.
2. Set the Source Viewer to Offline mode.
3. Drag a clip or timeline with matching timecode that you want to assign onto the Source Viewer. The clip or timeline you dragged is immediately assigned to the open timeline as an Offline Reference Clip, and synced via timecode.
4. In the Media Pool, right-click the Timeline you want to review against the Offline Reference Clip, and choose the reference clip or timeline you assigned from the Timelines > Link Offline Reference Clip submenu of that timeline’s contextual menu.

You can also add a clip to the Media Pool specifically as an Offline Reference Clip, making it easy to associate such a clip with a particular timeline by right-clicking that timeline in the Media Pool and choosing it from the Link Offline Video submenu. The idea is that if you or your client exports a flattened version of their edited sequence at the same time as they export the EDL, AAF, or XML project file they want graded, then you can compare the project data that’s imported into DaVinci Resolve to the actual video of the offline edit.

To assign an imported Offline Reference Clip to a specific timeline for comparison:

1. Open the Media page, and use the Media Storage browser to find the flattened Offline Reference Clip that you want to use for comparison.
2. Right-click the Offline Reference Clip file and choose Add as Offline Reference Clip.
3. That clip appears with a small checkerboard badge in its icon in the Media Pool.
4. Open the Edit page, right-click the timeline you want to review against the Offline Reference Clip, and choose the offline clip you imported from the Timelines > Link Offline Reference Clip submenu.
Setting Up an Offline Reference/Timeline Comparison

Once you’ve assigned a clip or timeline as an Offline Reference Movie, it’s easy to see a comparison.

**To view an offline reference comparison:**

1. Open the Source Viewer’s Mode pop-up menu and choose the checkerboard icon indicating Offline Reference.

The Offline Reference Clip you assigned previously now appears within the Offline Viewer, and plays back in sync with the Timeline. If your clips have sizing applied, have Fusion or other effects, or are graded, you can see a side-by-side comparison between the state of each clip in the Offline Reference Clip, and the graded Timeline clip.
2 If the currently selected Offline Reference is out of sync (which can be confirmed via the position of a slate, two-pop, title, or other known shared sync point at the beginning of the program), you can use the sync field at the upper left-hand corner of the Source Viewer in Offline mode to slip the sync of the reference by whatever number of frames you need.

3 If you like, you can optionally choose other ways of comparing clips, by right-clicking anywhere within the Timeline Viewer and choosing Vertical Wipe, Horizontal Wipe, Diagonal Wipe, Mix Wipe, Difference (a Composite mode), Box (wipe), Venetian Blind, or Checkerboard. These modes offer you different ways of quickly and directly comparing the content, sizing, color, and alignment of the Offline Reference Movie to the clips in your timeline.

Different viewing options for comparing the Offline Reference Movie to the Timeline are available in the Timeline Viewer contextual menu.

If you choose a wipe or difference comparison, that comparison will also be visible on the display connected to your video output interface, and dragging anywhere within the Timeline Viewer will adjust the ratio and position of the wipe.

4 To turn an offline comparison viewer mode off, simply right-click the Timeline Viewer again and choose No Wipe.

5 When you’re done doing this offline comparison, choose Source from the Source Viewer’s Mode pop-up menu, and the Source Viewer is ready for viewing clips from the Media Pool, as normal.
Chapter 57

Conforming and Relinking Clips

Whether you import a DaVinci Resolve project or a project exchange file from another application, you’ll need to deal with the need to relink media files in the Media Pool and reconform timelines to either the same or compatible media files that may either be in the Media Pool or that may need to be imported from disk.

This chapter discusses the rules with which DaVinci Resolve conforms clips to match timelines, and describes the numerous methods with which you can control clip linking, timeline conform, as well as how you can deal with problems that arise using the numerous problem-solving techniques that DaVinci Resolve makes available.

Contents

Conforming and Relinking Media 936
Conforming and Relinking During Project Import 936
Conforming and Relinking Existing Timelines and Clips 936
The Difference Between Unlinked and Missing Clips 937
Duplicate Clips are Considered Separate Sources 938
Summary of Methods for Conforming and Relinking 938
Unlinking Clips 940
Conforming Clips During XML and AAF Import 940
Importing Clips Before Importing an EDL, AAF, or XML 942
Essential Clip Metadata for Easy Conforming and Relinking 942
Defining Clip Metadata When Adding Media to the Media Pool 943
How Reel Names Are Identified 943
Conform Missing Clips by Importing Their Source Media 947
Conforming and Relinking Media

DaVinci Resolve provides a wealth of tools to help you deal with managing the relationship between clips in the Media Pool and clips in timelines, and with the links between each clip and its corresponding media file on disk. You can use these tools to manage different project workflows, or to deal with problems that can occur when importing project files in any format from a variety of sources.

This section describes every method available in DaVinci Resolve for conforming clips and relinking media. More information on the clip metadata that’s used to determine the correspondences between clips and media is found later in this chapter.

Conforming and Relinking During Project Import

When you import an AAF or XML file, you have the ability to relink the clips that are imported into the Media Pool to the corresponding source media files on disk as part of the process. As an automatic result, the imported timeline is conformed to the clips in the Media Pool, and you end up with a Media Pool full of clips, and an arrangement of those clips in the imported timeline. Because it all usually happens at the same time, it’s easy to confuse the distinction between a timeline’s relationship to the clips in the Media Pool, and each clip’s relationship to their corresponding source media file on disk.

The workflow for importing an EDL makes this process more explicit, since you must first import all of the clips you need into the Media Pool, making sure that they have the correct reel names and timecode. This creates the link between the Media Pool clips and the source media on disk. You then import the EDL in a second step, which creates a timeline that attempts to reconform itself to the clips in the Media Pool using reel name and timecode information.

Conforming and Relinking Existing Timelines and Clips

There are many reasons why you might want to reconform or relink media long after you’ve started editing or grading a project, so DaVinci Resolve provides additional tools to facilitate these workflows as well. For example, you may have started a project using placeholder VFX or stock footage clips, but you later need to replace these with final versions of the same shots. Or, you may have decided to edit a project using transcoded versions of the camera raw media files you were given, only to decide later that you want to switch one or all of the clips in the timeline to use the original camera media instead for grading and finishing. DaVinci Resolve has a wide variety of tools to support these workflows and more.
The Difference Between Conforming and Relinking

While these two terms are often used synonymously, conforming typically refers to the process of matching clips in a timeline to the appropriate source clips in the Media Pool, while relinking typically refers to the process of matching a source clip in the Media Pool to its corresponding media file on disk. This is a recent change necessitated by an expansion of relinking and reconforming options, so the author offers his apologies if this usage is not always consistent.

The Difference Between Unlinked and Missing Clips

While it may seem pedantic, there's an important difference between clips that are unlinked, and clips that are missing when it comes to the relationship between clips in the Media Pool and clips in a Timeline. First off, both of these “offline” clip states look different in the timeline, but these differences aren’t just cosmetic.

A missing clip in the Timeline (left) compared to an unlinked clip in the Timeline (right)

An unlinked clip is a clip that exists in the Media Pool, but has lost the link to its corresponding media file on disk. However, unlinked clips still contain metadata, they still have a relationship to instances of that clip that have been edited into timelines in your project, and they can be easily relinked to media files with matching file names and timecode using the Relink command (described later), or reconformed to previously or newly imported clips in specific bins of the Media Pool with the Reconform From Bins command (also described later).

Missing clips do not exist in the Media Pool at all, although clips flagged as missing can still appear in the timelines of your project. However, since missing timeline clips have no corresponding source clips in the Media Pool, the clip in the timeline has no metadata that can be seen in the Metadata Editor, and it will have lost any remote grades that are associated with that source clip (for more information about remote grades, see Chapter 139, “Grade Management.” You can fix missing clips in a timeline in one of two ways:

– If the “Automatically conform missing clips added to Media Pool” setting is enabled in the General Options panel of the Project Settings, then simply reimport the corresponding source clips into the Media Pool and they will be automatically conformed to missing clips with matching timecode and file names in the timeline (this only happens at the time of import, it doesn’t work for matching clips that are already in the Media Pool). Please note, this setting must be disabled if you use collaborative workflow.

– If the “Automatically conform missing clips added to Media Pool” setting is disabled in the General Options panel of the Project Settings, then you’ll have to import the missing clips and either manually reconform them one at a time to the missing timeline clips using the Conform Lock with Media Pool Clip command, or use the Reconform From Bin(s) or Import Additional Clips With Loose/Tight Filename Match commands to try reconforming them all at once.

However you choose to reconform the missing clips, you won’t get the original remote grades or manually edited metadata back unless you had previously exported the appropriate metadata and grades, in which case you can reimport and apply these in separate steps.
Duplicate Clips are Considered Separate Sources

Another thing that’s good to understand is that in DaVinci Resolve, duplicate clips are considered to be completely separate from the original Media Pool or Timeline clips you duplicated them from. For example, if you import five clips into Media Pool Bin 1, then edit them into a timeline, and then drag the five clips you edited into Media Pool Bin 2, the clips in Bin 1 are not intrinsically linked to the clips in Bin 2.

This means, if you select the clips you originally imported in Bin 1 and choose Unlink Selected Clips, the instances of those clips that you edited into the timeline will also be unlinked, but the duplicate clips you created when you dragged the timeline clips into Bin 2 are completely unaffected.

Summary of Methods for Conforming and Relinking

As a result of timelines and clips being managed separately, there are several ways you can reconform clips in a timeline to clips in the Media Pool, and clips in general to a project’s corresponding source media on disk. Which methods will be most valuable depend entirely on the workflow you’re using.

– **Conforming clips during XML and AAF import**: When you import a project via AAF or XML, you’re given the option of using the embedded file paths in the AAF or XML file to import all referenced media into the Media Pool for automatic reconforming to the clips in the imported timeline. If the media has been moved so that the file paths are invalid, then you’ll be asked to find the location of the media as part of the import process. You also have the option to ignore the AAF or XML file’s embedded file paths and instead import another set of media files in a different location (and perhaps in a different media format altogether) that have the same file names and timecode as the clips in the AAF or XML file you’re importing.

– **Importing clips before importing an EDL, AAF, or XML**: In EDL workflows, you must import the media an EDL will be conformed to into the Media Pool before you import the EDL. However, you can do this for AAF and XML import workflows as well. When you import clips into the Media Pool before importing an AAF or XML, DaVinci Resolve is able to automatically reconform the clips in the imported timeline to those in the Media Pool first, before next looking for media on disk for clips that could not be found in the Media Pool. This behavior depends on what options you’ve selected in the Import AAF/EDL/XML dialog.

– **Conform missing clips by importing their source media into the Media Pool**: As long as the “Automatically conform missing clips added to Media Pool” setting is enabled in the General Options panel of the Project Settings, DaVinci Resolve automatically tries to update the conformed relationship between clips you’re adding to the Media Pool and any missing clips in the various timelines of your project. This behavior is triggered whenever you add clips to the Media Pool by importing clips, copying and pasting, or creating duplicates of clips. For example, if a timeline clip is missing because there is no corresponding clip in the Media Pool, the simple act of importing a clip with a matching file name and timecode into the Media Pool will automatically reconform the missing timeline clip without you needing to do anything else. Please note, the “Auto conform clips with media added into Media Pool” setting must be disabled if you use collaborative workflow.

– **Using the Import Additional Clips commands**: The process of importing media just for missing clips in a timeline can be automated by right-clicking that timeline in the Media Pool and using the Timelines > Import > Additional Clips With Loose (or Tight) Filename Match contextual menu commands, which automatically search the selected directory tree of your file system for media that matches all of the offline clips in that timeline. The “Loose Filename Match” command ignores file extensions (letting you conform to alternate media formats), while the “Tight Filename Match” command requires file extensions to match.
– **Reconform online clips by importing new media into the Media Pool:** As long as the “Automatically conform missing clips added to Media Pool” setting is enabled in the General Options panel of the Project Settings, DaVinci Resolve automatically tries to update the conformed relationship between clips you’re adding to the Media Pool and any clips in the various timelines of your project that have their Conform Lock Enabled setting turned off. This behavior is triggered whenever you add clips to the Media Pool by importing clips, copying and pasting clips, or creating duplicates of clips.

By default, each clip that’s part of an imported timeline, or that you’ve edited into a brand new timeline, has Conform Lock Enabled turned on by default (unless the source media goes missing). Conform Lock Enabled simply means that a particular clip in a timeline is set to only consider the source clip in the Media Pool to which it’s currently conformed as the correct match; all other clips in the Media Pool are ignored, even if there are multiple clips with the same file name and overlapping timecode that would make them also a valid match (such as when you have multiple copies of the same clip that in different formats, or multiple versions of VFX clips with the same name and timecode).

If you right-click a clip with multiple potential matches in the Media Pool in the timeline and turn Conform Lock Enabled off, that clip will display a “clip conflict” error, with an attention badge to the left of its name in the timeline. Double-clicking that badge reveals a dialog showing you every clip in the Media Pool with a matching file name or reel name and overlapping timecode, so that you can choose which Media Pool clip you want to conform that timeline clip to.

Please note, the “Auto conform clips with media added into Media Pool” setting must be disabled if you use collaborative workflow.

– **Using Conform Lock commands to force a timeline clip to conform itself to a clip in the Media Pool:** A manual command for conforming a selected clip in the timeline with a selected clip in the Media Pool. Useful when none of the automated methods of conforming work, for whatever reason.

– **Using the Relink command on clips or bins in the Media Pool:** If you have a DaVinci Resolve project in which there are unlinked clips in the Media Pool, that means the relationship between those clips and their corresponding source media files on disk have been lost. In this case, you can use the Relink Media, Relink Selected Clips, or Relink Clips in Selected Bins commands to relink clips to the corresponding source media on whatever storage volume it’s on. In the process, you’ll automatically relink any instances of those clips in all timelines in which they appear in that project. You can relink only unlinked clips by selecting them specifically, but you can also relink clips that are already linked if you want to force relink them to different media files (Relink Clips in Selected Bins relinks both unlinked and linked clips at once). The Relink command automatically searches all subdirectories within the currently selected directory, which is useful if you’re relinking to media that’s been moved to another location, and that may have a different directory structure as a result. However, a warning about searching large SAN volumes – you probably don’t want to use this command to choose a starting directory that’s too high up the file path, as the resulting search times may be unexpectedly long.

– **Using the Change Source Folder command:** You also have the option to relink offline clips in the Media Pool using the Change Source Folder command, which changes the directory structure of each selected clip’s file path into a new file path based on a parent directory you select. This is mainly useful if you’re relinking clips to media that you’ve moved to another location, but that uses the same subdirectory structure as when the media was originally imported. For this reason, it’s a safe and fast command to use when relinking to a structured collection of media on a SAN volume.
– **Using the Reconform From Bin(s) command:** If you’ve imported multiple versions of the same clips, with identical file names, overlapping timecode, or other matching criteria into separate bins of the Media Pool, you can turn off Conform Lock Enabled for every clip in a timeline you want to reconform, and then use the Reconform From Bin(s) command to reconform those timeline clips to Media Pool clips in one or more specific bins of your choosing. Reconform From Bin(s) also lets you choose the specific conform criteria you want to use to match clips in the timeline with clips in the selected bins. A key feature of this command is that DaVinci Resolve will only reconform timeline clips that are able to be matched to media in the bins you’ve selected; timeline clips for which no match can be found are left as they were before you used this command.

– **Using the Reconform From Media Storage command:** This command lets you reconform timeline clips to clips in a selected directory in your file system that hasn’t been imported into the Media Pool first, and also lets you choose the specific conform criteria you want to use to match clips in the timeline with clips in the selected bins. A key feature of this command is that DaVinci Resolve will only reconform timeline clips that are able to be matched to media within the directory structure you’ve selected; timeline clips for which no match can be found are left as they were before you used this command.

– **Overwriting clips on disk that are linked to in a DaVinci Resolve project:** Last, but certainly not least, DaVinci Resolve is smart enough to automatically relink clips in the Media Pool that have been overwritten on disk by another version of the same file, so long as the file name, timecode, and reel name (if used) in the new version of the file still match.

The following sections illustrate each of these methods of conforming and relinking media in more detail.

### Unlinking Clips

You can also choose to unlink clips in the Media Pool. To do so, select the clip or clips you want to unlink, right-click one of the selected clips, and choose Unlink Selected Clips from the contextual menu.

### Conforming Clips During XML and AAF Import

For workflows where you’re importing AAF or XML projects, and relinking the resulting clips in DaVinci Resolve to media files that are either on disk, or conforming them to clips that are in the Media Pool already, the rules for how clip metadata is defined for reconforming depend on two settings in the Load AAF or XML dialog: “Automatically import source clips into media pool,” and “Ignore file extensions when matching.”

The most important settings for conforming media in the Load dialog

The ways in which these two checkboxes interact to let you choose how media is conformed to an imported AAF or XML file are complex, but here are the rules.
When Importing Clips With File Extensions Matching Those in the AAF or XML File

**Turn “Automatically Import” on and “Ignore file extensions” off.**

This is the default setting, and is most useful when the AAF or XML file you’re importing contains references to media you want to add to the Media Pool and use.

- First, if there are already clips in the Media Pool, DaVinci Resolve tries to conform as many of these clips as possible by matching the file paths in the AAF or XML file to the stored file paths of each clip in the Media Pool.
- Second, for all remaining clips not found, DaVinci Resolve imports as many clips as possible into the Media Pool from any storage volumes that are visible to DaVinci Resolve, using the file paths from the XML or AAF.
- Third, for all remaining clips not found, DaVinci Resolve tries a clip name match of clips that are already in the Media Pool.
- Fourth, for all remaining clips not found, DaVinci Resolve tries a timecode match (along with a reel name match if this is enabled) of clips that are already in the Media Pool.
- Finally, for all remaining clips not found, the user is prompted to manually choose another folder to search.

When Importing Clips With Different File Extensions

**Turn “Automatically import” on and “Ignore file extensions” on.**

Turning both of these options on is useful in situations where the sequence you’re importing was originally edited using offline quality media, and you want to conform to high-quality online media in a completely different format, possibly in the Media Pool, possibly on another disk. One example of this is as when the edit was done using QuickTime or Avid DNxHD media, but you’re reconforming to Blackmagic RAW files on another disk in order to grade the camera original raw media. Leaving “Automatically import source clips into media pool” on, in this case.

- First, if there are already clips in the Media Pool, DaVinci Resolve tries to conform as many of these clips as possible by matching clip names.
- Second, for all remaining clips not found, the user is prompted to choose another folder to search, and DaVinci Resolve imports as many clips as possible by matching clip names, ignoring file extensions.
- Third, for all remaining clips not found, DaVinci Resolve tries a timecode match (and reel name match if this is enabled in the General Options panel of the Project Settings) of clips that are already within the Media Pool.
- Fourth, for all remaining clips not found, the user is prompted to manually choose another folder to search.

**Turn “Automatically import” on and “Link to source camera files” on.**

The “Link to source camera files” checkbox only appears when you import AAF files. Turning this option on when automatically importing media relinks the imported project to the original camera source files that are kept track of by Media Composer/Symphony via the “Source Name” metadata within the AAF file.
When You’re Only Relinking to Clips Already in the Media Pool

Turn “Automatically import” off.

Turning “Automatically Import source clips into media pool” off is useful in situations where you only want to conform the imported AAF or XML to clips in the Media Pool. This is most useful in situations where you’ve imported all of the camera original media into the Media Pool first, for example when creating the dailies that were then edited, and you want to conform the imported AAF or XML to the media that’s already there.

– First, if there are already clips in the Media Pool, DaVinci Resolve tries to conform as many of these clips as possible by matching the file paths in the XML or AAF to the file paths stored for each clip in the Media Pool.
– Second, for all remaining clips not found, DaVinci Resolve tries a clip name match of clips that are already in the Media Pool.
– Third, for all remaining clips not found, DaVinci Resolve tries a timecode match (and reel name match if this is enabled) of clips that are already within the Media Pool. In this case, the file name is not used.

Beware When Choosing a Volume or Folder to Search

When prompted to choose a folder to search, you can optionally choose an entire volume; DaVinci Resolve always searches through all subdirectories, and eventually all media on that volume will be found. However, depending on the size and number of files on the selected volume, this operation could take an unexpectedly long time, especially on a SAN volume.

Importing Clips Before Importing an EDL, AAF, or XML

When you import media prior to importing an EDL, DaVinci Resolve follows a specific set of rules to determine which Media Pool clips correspond to clips in the resulting timeline. These rules also apply to situations where you’ve imported media prior to importing an AAF or XML file, in situations where you want to prioritize specific media over the file paths embedded in those imported timeline formats.

The following sections go into detail on what these rules are, and how to use them to your advantage.

Essential Clip Metadata for Easy Conforming and Relinking

When conforming projects in DaVinci Resolve, the accuracy and integrity of clip metadata is critical for a successful result. Keep the following three criteria in mind when you’re preparing media to use in DaVinci Resolve.

– **Accurate timecode**: Essential for every clip. First off, each clip should have a valid timecode track, and it should go without saying that the timecode should match the same timecode used by all other instances of that media file in a particular project. If there are problems with a clip’s timecode, DaVinci Resolve has tools you can use to edit or offset timecode to account for known inconsistencies. By default, the “Use Timecode” project setting is set to “Embedded in the Source Clip,” so that timecode is read from the embedded timecode track within a QuickTime or MXF file, or from the header data of a DPX frame file. However, you can also choose the “From the source clip frame count” option which enables timecode to be read from the Source clip’s frame count for image sequences.
When “Assist using Reel Names” in the General Options panel of the Project Settings is off (the default setting), this forces DaVinci Resolve to conform clips using file names when importing XML and AAF projects. File names can only be only used when conforming XML or AAF files, or when importing a DaVinci project; file names are never used when conforming EDLs.

Reel Name: Only used for conforming if “Assist using Reel Names” is on in the General Options panel of the Project Settings. Assigning reel names to your media is not essential, but recommended, and can make media management easier for certain operations, especially in EDL workflows. However, if you experience problems conforming clips with “Assist using Reel Names” turned on, you should try turning it off as one possible troubleshooting step.

How DaVinci Resolve matches media files to clips in an imported project depends on how you’re importing the project.

Defining Clip Metadata When Adding Media to the Media Pool

For workflows where you’re manually adding media files to the Media Pool when you’re editing from scratch in DaVinci Resolve, preparing to process dailies, or as a separate step before importing EDL, XML, or AAF project files and reconforming them to a higher quality set of media than what was originally used to edit with, the rules for how clip metadata is defined in preparation for conforming are a bit different.

Timecode: Calculated using the “Timeline Frame Rate” setting in the Master Project Settings panel of the Project Settings.

Reel Names: Determined depending on whether the “Assist using Reel Names from the” checkbox is on or off in the General Options panel of the Project Settings, and on which option you’ve selected. Reel names can be extracted dynamically, so any time you change this setting the reel names in the Media Pool update to reflect the change, or they can be defined manually, in which case you can set different clips to use different methods of reel name extraction.

Clip Names: Read and stored, used for AAF and XML imports, but not used for imported EDLs.

How Reel Names Are Identified

The “Assist using Reel Names” checkbox in the General Options panel of the Project Settings is an extremely important setting for controlling how the conform process works. By default, it’s turned off, and reel names are left blank. This is fine for conform workflows where all you need is the file path or file name and source timecode to successfully identify which media files correspond to what clips. However, if you need more information than that to reconform the clips in your project, you can turn on the “Assist using Reel Names” checkbox to enable DaVinci Resolve to use one of four different methods to automatically define reel names for every clip in the Media Pool.

Automatically Defining Reel Names

When you use the “Assist using Reel Names” options in the General Options panel of the Project Settings, reel names are extracted dynamically. This means that any time you change the method of reel name extraction in the Project Settings, the reel names of all clips in the Media Pool automatically update to reflect the change. This can be seen in the Reel Name column that’s visible if you put the Media Pool into List view. For example, were you to change the “Assist using reel names” options from “Source clip file pathname” to “Mediapool folder name,” the contents of the Reel Name column would visibly change. This is useful when you’re importing a project for which all clips use the same method of determining their reel name.
Manually Choosing Reel Name Definitions for Individual Clips

You also have the option of manually choosing the criteria for how one or more selected clips in the Media Pool have their reel names defined, using the Clip Attributes dialog. This is useful when there are certain clips in a project that need to use a different method of reel name extraction, or manually entered reel names.

To manually define reel names for one or more clips:

1. Select one or more clips in the Media Pool.
2. Right-click one of the selected clips, and choose Clip Attributes from the contextual menu.
3. Open the Reel Name panel of the Clip Attributes dialog, choose a new option, and click OK.

Once you’ve used Clip Attributes to change the reel names of clips, those clips no longer automatically update when you change the “Assist using Reel Names” options in the General Options panel of the Project Settings. For more information on using Clip Attributes, see Chapter 18, “Using Clip Metadata.”

Methods of Defining Reel Names

There are five options that are available for automatically determining how reel names are extracted from the source media when “Assist using Reel Names” is turned on, and one option in the Clip Attributes Reel Name panel for manually defining reel names. The use of reel names is critical in EDL and AAF workflows, but isn’t necessarily as important in XML-centric workflows.

- **Source clip file pathname:** Obtains the reel name by extracting it from each media file’s path. This makes it possible to extract a reel name from all or part of the file name, or from all or part of the name of any folder in the path that encloses that file. This extraction is defined using the Pattern field.

- **Pattern:** A code that defines how a reel name should be extracted from the source clip pathname. More information about creating patterns appears later in this chapter.

- **Media Pool folder name:** The reel name is obtained from the name of the bin in the Media Pool that encloses that clip. For example, in a stereoscopic workflow you might want to export offline stereo media with the “Left” and “Right” bin names in which they’re organized as reel names. Another example would be organizing VFX being incrementally processed in individually named bins, such as “VFX_Tuesday_10-12.”

- **Embedding in Source clip file:** Useful for file formats where the reel name is embedded within the media file itself. Blackmagic RAW and other digital cinema cameras, QuickTime files created by Final Cut Pro, and DPX frame files are formats that can contain reel name header data.

- **Source clip filename:** If there is no defined reel number, often it’s easy to just use the Source clip filename.

- **User Defined:** This option is only available when you manually alter the Reel Name for one or more selected clips in the Media Pool using the Clip Attributes dialog. Choosing User Defined lets you type any string of text you like to use as the reel name.

An additional checkbox is available, “Extract reel names from EDL comments,” which is primarily useful for legacy workflows in which you conform an EDL exported from Final Cut Pro 7 to camera original R3D media.

- **Extract reel names from EDL comments:** Some media file formats, such as R3D, have reel names, obtained from the file names, that are longer than the eight characters that are allowable in a standard EDL. This option allows DaVinci Resolve to extract reel names from appropriately formatted EDL comments, such as those output from Final Cut Pro 7.
Using the Pattern Field

If you’re using the Pattern option to extract the reel name from a clip’s source file pathname, you have the option to create your own search pattern, enabling you to have DaVinci Resolve extract the reel name in highly specific ways to accommodate more exotic workflows.

Extraction patterns are interpreted from right to left, deciphering each clip’s file path element by element starting with the file name, and then considering each enclosing directory’s name to the left. Each extraction pattern consists of a series of text characters and “wild card” operators in unique combinations corresponding to the length and names used in the file path.

Here are a series of search characters that may be used.

<table>
<thead>
<tr>
<th>Extraction Pattern Operators</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
</tr>
<tr>
<td>*</td>
</tr>
<tr>
<td>%R</td>
</tr>
<tr>
<td>%_R</td>
</tr>
<tr>
<td>%D</td>
</tr>
<tr>
<td>/</td>
</tr>
</tbody>
</table>

If you’re trying to create a new extraction pattern for a unique workflow, there’s a test dialog you can use to try different patterns out before applying them to your project.

**To test the extraction path:**

1. Turn on “Assist using reel names from the” and click the Test button next to the current Pattern in the General Options panel of the Project Settings. The “Specify Reel Extraction Pattern” dialog opens.
2. Type the extraction pattern you want to test into the Pattern field.
3. Using whatever method you prefer, find the file path of the media file that you want to test the extraction pattern on, and copy or type it into the Sample Path field.
4. Click Test.
5. If the reel name that appears below is correct, then click Apply to copy the extraction pattern into the Pattern field of the General Options panel of the Project Settings. If the reel name that appears is not correct, modify the extraction pattern and try again.

**Examples of Reel Name Extraction Patterns**

To better understand how this process works, below are several examples showing the various methods of reel name extractions. The / is used as the separator between control parameters.

**Example 1:**

This example shows the reel name stored within the parent folder name of the clip.

- **Pattern:** *%R/%D
- **File path:** vol0/MyMovie/Scans/004B/Frame{1000-2000}.dpx
- **Reel name:** 004B
Parsing takes place from right to left so to analyze this pattern start at the right end. In this case the `%D matches to the file name “FrameNNNN.dpx” where NNNN is the frame number in each file of the clip. Moving left of the file name, the `/%R/` section of the string is next. This specifies that the reel name will be the entire name of the parent directory immediately above the file. Then the `*` at the beginning of the string says match any pathname in front of the directory name that has the reel name. This string would find the parent directory regardless of how many levels deep it is nested on the directory path.

**Example 2:**
Here we see the reel name stored in the parent folder name of the clip and prefixed with the reel name.

- **Pattern:** `*/????%R/%D` or alternatively `*/Reel%R/%D`
- **File path:** `/vol0/MyMovie/Scans/Reel1234/Frame[1000-2000].dpx`
- **Reel name:** 1234

In this example both of these extraction patterns produce the same result. They are also similar to the first example. The reel name is still in the parent directory name but in this case it will have the fixed characters “Reel” prefixed in front of the reel name. The first pattern with `????` would actually match with any 4 characters in front of the reel name. The second pattern is more specific and would only match the word “Reel” in the directory name.

**Example 3:**
This example shows the reel name stored within the parent folder name two directory levels up.

- **Pattern:** `*/%R/%D/%D`
- **File path:** `/vol0/MyMovie/Scans/004B/134500-135000/Frame[1000-2000].dpx`
- **Reel name:** 004B

This example is again similar to Example 1. The difference is that in Example 3, the reel name is the directory name two levels above the clip. In Example 1, the reel name was in the directory name only one level up.

**Example 4:**
Finally, we see the reel name that is embedded within the clip name of the material.

- **Pattern:** `*/Reel%R_*`
- **File path:** `/vol0/MyMovie/Scans/Reel004B_[1000-2000].dpx`
- **Reel name:** 004B

This example shows a method for extracting the reel name from the file name of the clip. Again, starting at the right the two pattern characters “_*” match any series of characters up to the first underscore character. In this case it will pick up the file extension (.dpx) and the frame number portion of the file name. Next, the “/Reel%R” characters indicate the reel name is the characters between the “/Reel” and _ character. The `*` at the beginning of the pattern will match a file path any number of directories deep in front of the file name.
Conform Missing Clips by Importing Their Source Media

If you have a timeline with one or more missing clips, that means that the relationship between that clip in the timeline and the Media Pool has been lost because there is no corresponding clip in the Media Pool. If you decide to manually import clips into the Media Pool that correspond to missing clips, the “Automatically conform missing clips added to Media Pool” checkbox in the General Options panel of the Project Settings determines what happens. Please note, the “Auto conform clips with media added into Media Pool” setting must be disabled if you use collaborative workflow.

As long as the “Auto conform clips with media added into Media Pool” setting is enabled in the General Options panel of the Project Settings, DaVinci Resolve automatically updates the conformed relationship between clips that you add to the Media Pool and missing clips in the various timelines of your project. DaVinci Resolve also updates the conform relationship of all other timeline clips that have Conform Lock Enabled turned off at this time as well. All of this is done at the time you import the clips.

However, if “Auto conform clips with media added into Media Pool” is turned off when you import additional clips into the Media Pool, then DaVinci Resolve will not attempt to reconform anything automatically, instead relying on you to reconform offline or missing clips manually using one of the many methods of manual reconforming that are available such as Reconform From Bins or Conform Lock With Media Pool Clip.

For more information about manually adding clips to the Media Pool, see Chapter 17, “Adding and Organizing Media with the Media Pool.”

Using the Import Additional Clips Command

If you find that there are a lot of missing clips in a timeline that have no corresponding Media Pool clips, there’s an easy way to fix this, that automates the process of gathering a list of what’s missing so as to import all missing clips and conform them at once. This only works for missing clips, it does not work for unlinked clips (for which you should use the Relink command in the Media Pool).
To import missing clips and reconform them to the Timeline:

1 In the Edit page, right-click a timeline in the Media Pool that has missing clips, and choose one of the following commands from the Timelines > Import submenu:

- **Timelines > Import > Additional Clips With Loose Filename Match**: Searches the Timeline for all missing clips, and prompts you to specify a directory of media with which to attempt to conform them, adding only the media that's necessary to the Media Pool. The “Loose Filename Match” command ignores file extensions, which lets you replace offline media with online media in a different format.

- **Timelines > Import > Additional Clips With Tight Filename Match**: Searches the Timeline for all missing clips, and prompts you to specify a directory of media with which to attempt to conform them, adding only the media that's necessary to the Media Pool. The “Tight Filename Match” command searches only for media with identical file extensions.

2 Choose the directory with the remaining media to be conformed in the dialog that appears, and click OK.

If the conditions are met for matching the media files in the directory you selected to the missing clips in the current Timeline, then the necessary clips are automatically added to the Media Pool and conformed to the timeline.

### Using Conform Lock As a Command

If, for whatever reason, an unlinked clip in a timeline simply won't conform to a clip in the Media Pool, even when you know it's there, you can use the “Conform Lock with Media Pool Clip” command to force a clip in the Timeline to conform to a clip in the Media Pool of your choosing.

This command automatically suspends the Conform Lock Enabled setting of a target clip and ignores file names and reel names in favor of conforming the target clip to another clip that you've manually selected, while timecode is still used to align the clip being conformed with the clip that was in the Timeline originally.

To conform lock a clip in the Timeline to another clip in the Media Pool:

1 Select a clip in the Media Pool. The clip you select in the Media Pool must be equal in length or longer than the clip you select in the Timeline for Force Reconform to work.

2 Right-click an unconformed clip in the Timeline, and choose “Conform Lock with Media Pool Clip” from the contextual menu. The selected clip in the Timeline is conformed to the clip you selected in the Media Pool in one of two ways:

- **If the selected Media Pool clip has timecode matching the selected Timeline clip**: The new clip is perfectly conformed to match the original clip.

- **If the selected Media Pool clip doesn't have timecode matching the selected Timeline clip**: The new clip is conformed such that the first frame of the Media Pool clip is aligned with the first frame of the reconformed clip in the Timeline, and occupies the same duration.

3 If you right-click that clip again, you'll see that Conform Lock Enabled is enabled, showing you that the clip has been conform locked to media for which it wasn't originally a match.
Relinking Clips to Media Files on Disk

The easiest and best known method of relinking clips in your project that have either gone offline or are not linked to the correct set of media files on disk is to use the appropriately named “Relink Media” or “Relink selected clips” command. Note, the Relink command will only work for clips that are unlinked, it will not work for clips that are missing and so have no corresponding clips in the Media Pool.

The Relink command is the most flexible method of relinking clips in the Media Pool of your project with clips in a file system directory of your choice, using file name and timecode as the primary criteria for re-creating the correspondence between each clip and its corresponding media file on disk. This is a good command to use to relink media that’s been moved to another location or reorganized using another file structure on disk.

To relink all unlinked media:
1. Select the orange Relink icon in the page’s Media Pool.
2. Select the Locate button next to the specific volume(s) that are missing, and choose a directory where the missing files are now.
3. If the quick search initiated by the Locate buttons doesn’t find media that you know is there, you can initialize an exhaustive deep disk search for the media by clicking on the Disk Search button.
4. If there are still other clips that couldn’t be found, you’re prompted to either choose another directory altogether to continue searching, or quit.

To relink selected clips:
1. Select one or more offline clips to relink, or select a bin in the Media Pool bin list that contains clips you want to relink, then right-click one of the selected clips or the selected bin, and choose “Relink Selected Clips” from the contextual menu.
2. When the Relink File dialog opens, choose a directory in which to look for the files you want to re-link to, and click OK. DaVinci Resolve attempts to find every clip with a matching file name in the subdirectories of the directory you chose, using the original file paths of the clips being relinked to do this as quickly as possible. By first looking for the clips in the directories they were originally in, relinking can be quite fast.
3. If there are any clips that couldn’t be found using the method in step 2, you’re prompted with the option to do a “deep search” by a second dialog. If you click Yes, then DaVinci Resolve will look for each clip inside every subdirectory of the directory you selected in step 2. This may take significantly longer, but should be completely successful so long as the media that’s required is within the selected directory structure.
4. If there are still other clips that couldn’t be found, you’re prompted to either choose another directory altogether to continue searching, or quit.
Using “Change Source Folder” to Relink Clips

If you’ve used your file system to move media that’s associated with a DaVinci Resolve project, but you haven’t changed the directory structure with which it’s organized, you can use the “Change Source Folder” command to quickly relink selected clips in the Media Pool to the new file path of the media on disk, using the original file paths as a guide. This is a good relinking method to use, if possible, for projects on a SAN where you don’t want to risk the excessively long search times that could result from using the Relink command to examine a nested hierarchy of folders in a more flexible way.

To relink your Media Pool clips to a new location:

1. Select one or more clips in the Media Pool, then right-click one of the selected clips, and choose “Change Source Folder” from the contextual menu. The Relink Media window appears displaying the original path for the material, with controls for choosing a new directory.

2. Click the “Browse” button to the right of the “Change To” field, and then use the file navigation dialog to find the new location of the media file, select it, and click Open.

3. If you succeeded in finding the appropriate media file, click Change. Otherwise, click Cancel.

Using the “Reconform From Bins” Command

The “Reconform From Bins” command gives you a way of reconforming multiple clips in a timeline at once to a specific bin (or bins) of clips with matching metadata. To use this command, you must first select the clips you want to reconform in a timeline (you can choose all of them or just a subset) and turn off Conform Lock Enabled, and then, using the Reconform From Bin command, you can manually choose another bin of clips in the Media Pool that you want to reconform to.

An important aspect of the Reconform From Bins command is that DaVinci Resolve only reconforms timeline clips that can be matched to source clips in selected Media Pool bins. All timeline clips that cannot be matched are left alone. This makes Reconform From Bins an ideal command to use when you’ve imported a subset of clips to the Media Pool that you need to reconform to clips found throughout an existing timeline. For example, you could use this method to:

- Replace transcoded versions of clips in a timeline with the original camera raw clips.
- Replace the previous versions of VFX clips in a timeline with new versions.
- Replace the offline-quality media you’ve been working with so far with online-quality media.
- Replace the temp clips you were originally given with rescanned or recaptured stock footage.

To use Reconform From Bins, it’s important to organize the clips you’re adding to the Media Pool sensibly, in a self-contained bin or bins separate from the other media used by that timeline. It can be a sub-bin, but it must be separate.

Here’s a simple example. If the media you edited or originally imported is in Bin 1, then import the updated versions of all clips that need to be reconformed into Bin 2. Using Reconform From Bins, you can then decide whether the clips in your timeline should be conform to Bin 1, or Bin 2 when possible, because only timeline clips for which there is a valid match are reconformed, while all other timeline clips are ignored.

DaVinci Resolve has the ability to choose custom conform options to control what metadata is used to match timeline clips to source clips in the Media Pool. This means that you’re not restricted to only using Timecode, Reel Name, and File Name, you could also use any combination of Total Duration,
Resolution, Bit Depth, Frame Rate, File Format, Codec, and/or Media UMID/UID to control how clips are conformed, depending on your needs and the problem you have to solve.

The Reconform From Bins dialog

However, if the criteria you’ve selected to control the conform doesn’t match, the Reconform From Bins operation will fail, and you’ll need to either try again with other conform criteria, or manually replace the necessary clips in the Timeline.

Here’s a step by step workflow.

**To reconform a timeline to clips within a specific Media Pool bin:**

1. Double-click the Timeline you want to reconform to open it.
2. Either select the specific clips you want to reconform, or press Command-A to select every clip in the Timeline if you want to reconform clips throughout the entire timeline without having to make individual selections.
3. Right-click one of the selected clips, and choose “Conform Lock Enabled” to disable Conform Lock Enabled for the clips you want to reconform. This frees DaVinci Resolve to consider all possible conform matches for those clips in cases where there may be multiple clips with overlapping timecode in the Media Pool.
4. Right-click the current Timeline in the Media Pool, and choose Timelines > Reconform From Bins. The Conform Options dialog appears, with Timeline Options and Choose Conform Bins list to the left, and the Conform Options panel to the right.
5. From the Timeline Options section, choose whether you want to conform to All Clips or just to Selected Clips. Then, choose whether you want to “Set clips to Conform Lock Enabled” after conform.
6. In the Choose Conform Bins section, click the disclosure triangle to the left of the Master bin to reveal the sub-bins contained within.
7 Turn on the checkboxes for the bins with media you want to conform the Timeline to, and turn off the checkboxes for bins with media that you want to ignore.

8 Next, choose the conform options you want to be considered when matching timeline clips to Media Pool clips in the selected bins. By default, Timecode is enabled. Choose additional criteria to be even more selective about how you want clips to be reconformed, or choose different criteria if you need to use other metadata to get better results for clips you’re having a hard time conforming.

9 Click OK. Where possible, the Timeline is automatically updated to conform to the media contained within the bins you checked.
After you’ve used “Reconform From Bins,” any timeline clips that have been reconformed and that now have timecode and reel names/file names that match two or more source clips in the Media Pool will display a clip conflict badge in the Timeline. To eliminate this badge, you can select either just the clips that were conformated, or all clips in the Timeline, right-click them, and choose Conform Lock Enabled to eliminate these warnings.

Using Reconform From Media Storage

DaVinci Resolve 14 introduces another reconform method, that lets you conform clips in a timeline to clips in a specific File System directory (including all subdirectories) using the “Reconform From Media Storage Folders” command. This allows you to conform multiple clips in a timeline, all at once, to matching source media files on disk without having to import those clips to the Media Pool first; all clips that can be conformated according to the specified conform criteria will be automatically imported as necessary.

An important aspect of the Reconform From Media Storage command is that DaVinci Resolve will reconform all timeline clips that can be matched to source media files on disk in the selected Media Storage directories, but all Timeline clips that cannot be matched are left alone. This makes Reconform From Media Storage an ideal command to use in the following situations:

– When you need to reconform clips that are found throughout an existing timeline to a smaller subset of media in a specific directory on disk, such as updated VFX or Motion Graphics from a third-party application.
– When you need to quickly reconform missing timeline clips throughout an imported timeline, and especially when you need to use custom conform criteria to successfully reconform those clips. (Unlinked clips can only be reconformed with this command if you select them and turn off Conform Lock Enabled first.)

Similar to the Reconform From Bins command, you can specify exactly what combination of conform criteria you want to use to match clips in the timeline with clips in the Media Pool. This means that you’re not restricted to only using Timecode, Reel Name, and File Name, you could also use any combination of Total Duration, Resolution, Bit Depth, Frame Rate, File Format, Codec, and/or Media UMID/UID to control how clips are conformated, depending on your needs and the problem you have to solve.
This method of timeline conform is ideal when the only way you can conform a timeline to the media you require is using a very specific combination of metadata that’s different from the rules that DaVinci Resolve defaults to.

For example, you have a jumbled mix of 8- and 10-bit versions of the same clips on your hard drive, but you only want to conform a given timeline to the 10-bit media in preparation for finishing. Using “Reconform from media storage folders” lets you be this specific with what media to use.

**To use “Reconform from media storage folders” to reconform a timeline:**

1. Double-click the Timeline you want to reconform to open it.
2. Either select the specific clips you want to reconform, or press Command-A to select every clip in the Timeline if you want to reconform clips throughout the entire timeline without having to make individual selections.
3. Right-click one of the selected clips, and choose “Conform Lock Enabled” to disable Conform Lock Enabled for the clips you want to reconform. This frees DaVinci Resolve to consider all possible conform matches for those clips in cases where there may be multiple clips with overlapping timecode in the Media Pool.
4. Right-click the timeline you want to reconform, and choose Timelines > Reconform from media storage folders. The Import From dialog appears, with a File System browser to the left, and an Options panel to the right.
5. From the Timeline Options section, choose whether you want to conform to All Clips or just to Selected Clips. Then, choose whether you want to “Set clips to Conform Lock Enabled” after conform.

![Timeline Options](image)

Choosing which clips in the Timeline to attempt to reconform

6. From the Conform Folders section, choose a directory that contains media you want to reconform to.

![Choose Conform Folders](image)

Selecting a directory that has media you want to conform to

7. Next, choose the conform options you want to be considered when matching timeline clips to source media files in the selected directory. By default, Timecode is enabled. Choose additional criteria to be even more selective about which clips will be reconformed, or choose different criteria if you need to use other metadata to get better results.
Selecting criteria to guide the reconform

**TIP:** Choosing Custom from the top of the pop-up menu for File Extensions, File Format, and Codec displays editable fields into which you can enter multiple options, separated by commas, in order to list multiple possibilities for a successful match. The order in which you enter these is important, as DaVinci Resolve will attempt to conform clips starting with the first format/codec at the left, moving to try the next format/codec to the right if no match is found, until every entry in your list has been tried.

8 Click OK. Where possible, the Timeline is automatically updated to conform to the media in the directory you selected, and all source media files that were conformed have been imported into the Media Pool.

9 After you’ve used “Reconform From Media Storage Folders,” any timeline clips that have been reconformed and that now have timecode and reel names/file names that match two or more source clips in the Media Pool will display a clip conflict badge in the Timeline. To eliminate this badge, you can select either just the clips that were conformed, or all clips in the Timeline, right-click them, and choose Conform Lock Enabled to eliminate these warnings.

Understanding, Fixing, and Using Reel Conflicts

As long as the “Auto conform clips with media added into Media Pool” setting is enabled in the General Options panel of the Project Settings, the same dynamic relationship between clips in the Media Pool and those in a timeline are maintained whether clips are linked or unlinked, it makes no difference. However, this does mean that if you have two different versions of the same clip in the Media Pool, or even two completely different clips that share the same file name (or reel name) and the same overlapping timecode, then DaVinci Resolve is capable of automatically conforming to either clip.
A good example of this is if you have both the camera raw version of a clip, and a ProRes or MXF transcoded version imported into the Media Pool at the same time. Both clips have the same content, the same file name, and the same range of frames. This poses the potential for what DaVinci Resolve refers to as a “clip conflict.”

You won’t necessarily notice this at first because, by default, all clips that are imported with a timeline, or that you’ve edited into a brand new timeline, have a Conform Lock Enabled setting enabled by default. All clips in a timeline with Conform Lock Enabled turned on only consider the current clip in the Media Pool to which they’re conformed as the valid clip; all other clips with file names and overlapping timecode that would otherwise make them an otherwise valid match are ignored.

However, if you right-click such a clip in the Timeline and turn Conform Lock Enabled off, that clip will display a “clip conflict” error, with an “attention” badge to the left of its name in the Timeline.

Clip conflicts are typically considered to be an error, but not always. They can be a problem if the media you’ve imported along with an imported project from another application has media that was added with timecode but no reel identifier (for example, when shots from multiple unidentified reels that all start at 0 hour). The thing is, you may not immediately notice such clip conflicts, until you turn Conform Lock Enabled off.

**TIP:** Overlapping timecode often occurs in the normal course of work, but should be managed by altering each clip’s embedded reel name, or by organizing media in different bins.

### Using Clip Conflicts as a Conform Tool

On the other hand, clip conflicts can often be desirable solutions to workflows where you need to switch among different versions of a particular clip. To take the example of an edited timeline consisting of transcoded QuickTime versions of camera raw original media, if you only had the transcoded clips in the Media Pool, then all is well.

However, suppose in the course of working that you decide you need the resolution or additional color latitude of the camera raw version of a particular clip. If you import the camera raw version of that one clip, you should notice nothing different. However, if you then right-click that clip in the Timeline and choose Conform Lock Enabled to uncheck the setting and turn it off, you should then see the attention badge to the left of the clip name in the Timeline. This lets you know that this clip in the Timeline is correctly seeing the relationship between it and the now two simultaneously named clips with timecode overlap in the Media Pool.

The current relationship between this timeline clip and the one to which it is conformed doesn’t change; this badge is only letting you know that now there is a second clip in the Media Pool to which you could potentially conform this clip in the Timeline. Now, you need only choose which one by double-clicking the clip conflict badge, and following the procedure below.
Resolving Clip Conflicts

Once you have a clip conflict, whether intentional or not, it’s really easy to resolve it. In fact, this feature is the very basis for the name of the software.

To resolve a reel conflict by relinking a clip’s media:

1. Double-click the “attention” badge of any clip in the Timeline, displayed to the left of that clip’s name.

The Conflict Resolution window appears, showing a list of all files in the Media Pool, of any format, that have identical file names (or reel names) and timecode that overlaps with the clip you right-clicked. Each item in this list shows a thumbnail of the clip, the file path of the media on disk, the file name, starting timecode, reel name (if any), and creation date, to help you determine which of the clips in that list is the one you want to use.

2. Click the entry in the list that you want to conform to, and click Apply. The clip in the Timeline changes to reflect the media you selected, and the “attention” icon is replaced with a “resolved” badge indicating that the conflict has been resolved. Keep in mind that you can always double-click the “resolved” badge to change which Media Pool clip you want to conform to. It remains a dynamic relationship.
Re-editing Media Directly to the Timeline

If, for whatever reason, none of the above methods of relinking or reconforming have worked, sometimes the only thing left to do is to replace the problem clip in your timeline with a different clip. For example, you may need to replace an old version of an effects shot with a newer one, or you need to replace an offline version of a stock footage shot with a higher quality one, and the problem is that you’ve got a mismatched filename and/or timecode, no reel name, and the files are completely different formats, frame sizes, and durations.

In this case, it’s a good thing that DaVinci Resolve has such good editing tools. For more information on editing, see Chapters 34 through 47. When fixing conform problems via manual editing, the replace edit is your special friend. For example, you could use a replace edit to match a new incoming clip’s timing to the old one. Or you could use a three-point edit, a place on top edit, or even a simple drag and drop edit to put the new clip into the Timeline to take the place of the old one. For specific information on the different edit types in DaVinci Resolve, see Chapter 37, “Editing Basics.”

How Grades Are Linked to Multiple Timelines

If you’ve set your project up to use Remote versions, then any clips that refer to the same file in the Media Pool are linked and share the same Remote versions of grades that are applied to them. For example, two clips that are close-ups from the same take refer to the same media file, so they’re both automatically linked to one another and share the same remote grades.

Clips using Remote versions also exhibit this behavior when they appear in multiple timelines. Clips using Remote versions that are located in different timelines, but that refer to the same file in the Media Pool, are linked and share the same remote versions of grades. This is why you can grade one timeline, and then import a re-edited version via EDL, AAF, or XML, and have the new timeline automatically inherit all grades from the previous timeline.

However, you can override this behavior to have one timeline that’s independently graded from the others. Simply select that timeline, open the Color page, right-click any clip in the Thumbnail timeline, and choose Copy Remote Grades to Local from the contextual menu. All grades are copied to Local versions, and from that point on all changes you make to grades in that timeline have no effect on the other timelines in your project.

For more information about Local and Remote versions, see Chapter 139, “Grade Management.”
Creating Digital Dailies for Round Trip Workflows

DaVinci Resolve can be used to create media for editors to use in other applications in situations where those applications are unable to import a given project format but DaVinci Resolve can. In the process, you can use DaVinci Resolve’s many organizational, effects, and grading capabilities to create media that’s a pleasure to edit with, normalizing log-encoded media, syncing dual-source audio in a variety of ways, and doing some fast (or not-so-fast) grading to make sure that the media being edited looks its best.

Furthermore, once you’ve created a project to accomplish these tasks, you’ve also given yourself a jump-start on reconforming the project should your workflow be to move the edited project back into DaVinci Resolve for editing and finishing. This chapter covers a workflow for importing, preparing, and outputting media for these situations.

Contents

Step 1—Ingest Media and Add/Edit Metadata 960
Step 2—Sync Audio to the Dailies 960
Step 3—Do Whatever Grading is Necessary 961
Step 4—Export Media Suitable for Editing 963
Step 5—Reconform Media to an EDL, AAF, or XML Project File 964
Step 6—Output Final Media for Finishing 964
Step 1–Ingest Media and Add/Edit Metadata

It’s not necessary to have a project file exported from an NLE to start working in DaVinci Resolve. Using the Media Storage browser on the Media page, you can access any volume that’s currently available to the system, and import any compatible media format into the Media Pool.

The Media Pool is DaVinci Resolve’s internal database of available media for the currently open project. If you like, clips in the Media Pool can be organized into multiple bins. Once media has been added to the Media Pool, you can access a variety of descriptive metadata using the Metadata Editor, adding descriptions, notes, scene and take information, flags, day and date information, program and episode information, and so on. This data can populate metadata tags when exporting ALE lists to move the metadata to a compatible NLE.

For more information on ingesting media in the Media page, see Chapter 17, “Adding and Organizing Media with the Media Pool."

Step 2–Sync Audio to the Dailies

If your video format has embedded audio, DaVinci Resolve can simply pass that audio through when outputting media from the Deliver page. However, if the program you’re working on employs dual-system audio recording, there are a variety of methods available for syncing it in the Media page. You can also import timecoded Broadcast WAVE files into the same bin as the accompanying video clips (you can place them into a sub-bin if you like), in preparation for syncing the dailies in DaVinci Resolve.

Once you’ve imported the video and audio media you want to sync into the Media Pool of the Media
page, you can right-click the enclosing folder and choose “Auto-Sync Audio Based on Timecode” which automatically syncs every timecode-matched pair of audio and video media clips within the same folder, all at once. Alternately, you can choose “Auto-Sync Audio Based on Timecode and Append Tracks” to add the synced audio tracks to any audio tracks already present in the video clips.

**TIP:** For the best results, consider using different folders for each day’s audio and video clips.

If you don’t have synced timecode, but your video clips have separately recorded audio (usually via an on-camera microphone) that matches the dual-system audio recordings, you can use waveform syncing to quickly sync each video clip with its matching audio clip. Import your separately recorded audio files into the same bin as the accompanying video clips (you can place them into a sub-bin if you like), in preparation for syncing. Once imported, you can right-click the enclosing folder and choose “Auto-Sync Audio Based on Waveform” which automatically syncs every timecode-matched pair of audio and video media clips within the same folder, all at once. Alternately, you can choose “Auto-Sync Audio Based on Waveform and Append Tracks” to add the synced audio tracks to any audio tracks already present in the video clips.

**TIP:** With waveform syncing, for the best and fastest results, consider using different folders for each day’s audio and video clips, or even different folders for each scene, to reduce the number of waveforms that need to be compared at one time.

Finally, if all you have in the way of sync reference is a humble clapboard, you can manually sync video and audio clips by selecting a video clip to open into the Media page viewer, and then clicking the Waveform button in the Audio panel and clicking the corresponding audio clip to show its waveform in the audio panel. In this way, you can drag the Viewer and Audio panel’s playheads to the video and audio sync points, and click the Audio panel’s link button to lock the A/V sync of that clip.

For more information on syncing audio and video in the Edit page, see Chapter 21, “Modifying Clips and Clip Attributes.”

**Step 3–Do Whatever Grading is Necessary**

Many productions that decide not to record camera raw media instead elect to record a log-encoded or “flat” image to ProRes or DNxHD media files in order to preserve the most image data for grading without clipping highlights or shadows. This can be accomplished using in-camera settings that record log-encoded QuickTime or MXF media, or via external video recorders such as the Blackmagic Video Assist. Depending on the camera you’re shooting with, the recorded media will use one of a variety of log-encoded gamma curves such as Log-C, S-Log, S-Log2, S-Log3, BMD Film, CanonLog, Panasonic VLog, or REDlog Film, among others.

In other workflows, raw video formats are recorded and later debayered as log-encoded clips in order to preserve the maximum amount of debayered data for grading, or in preparation for transcoding.

If you’re outputting high-quality media files meant to be used themselves for later finishing, then you may want to simply pass the source image data through unaltered. However, if you’re creating offline media for editors, directors, and producers to watch for the next three months, you can grade this data in a variety of ways to provide more pleasing output that’s been “normalized” in order to look closer to what was monitored on-set during the shoot.

There are many ways of normalizing log-encoded media in DaVinci Resolve. If you’re working with one or more raw formats, you can choose to debayer all clips straight to Rec. 709 in the Camera Raw panel of the Project Settings. However, if you’re working with log-encoded ProRes or DNxHD media, you need to normalize these clips using other methods.
An easy and powerful way to do so is to use DaVinci Resolve Color Management. To do so, set the “Color science” setting within the Color Management panel of the Project Settings to “DaVinci YRGB Color Managed.” Then, right-click each clip or group of clips in the Media Pool, and choose the appropriate setting for each type of media from the Input Color Space submenu (you can define the Input Color Space of multiple selected clips at once). For more information on using DaVinci color management, see Chapter 8, “Data Levels, Color Management, and ACES.”

Enabling DaVinci Resolve color management

If you don’t want to use DaVinci color management, you can also use one or more LUTs (Lookup Tables) to normalize log-encoded media. You can apply a LUT to the entire project to normalize the particular log characteristics of the media you’re processing. Project-wide LUTs can be applied in the Color Management panel of the Project Settings. For more information, see Chapter 4, “System and User Preferences.”

In the case of LUT-managed shooting workflows where a variety of LUTs have been custom-designed to monitor different scenes, you can manually apply individual LUTs to one or more selected clips from each scene using the Media Pool’s contextual menu.

You can also edit each scene’s clips into timelines, and apply separate LUTs to each clip in the Clip mode of the Node Editor of the Color page, or apply a single LUT to an entire timeline using the Timeline mode of the Node Editor. For more information on using LUTs as part of grades, see Chapter 140, “Node Editing Basics.”

Alternately, if on-set color correction from the shoot been provided via a CDL-compliant EDL exported from one of several on-set grading solutions that are available, you can use the ColorTrace™ from CDL.
command to batch import grading information from another application. For more information on CDL import workflows, see Chapter 146, “Copying and Importing Grades Using ColorTrace.”

Selecting Timeline in the Node Editor

If your project’s workflow requires that you start out with even higher quality dailies, you can go ahead and manually grade individual clips as you would with any project. However, if you want to create a fast “one-light” adjustment for every clip in the Master Timeline at once, you can use the Timeline grade mode of the Node Editor in the Color page to apply a single correction simultaneously to every clip in the current Timeline. This is particularly useful as you can readjust the Timeline grade as much as you like, and the changes are automatically applied to every clip in the Timeline. For more information, see Chapter 140, “Node Editing Basics.”

Step 4–Export Media Suitable for Editing

Once you’ve organized your clips, synced the dailies, and applied whatever grading is necessary for the purpose at hand, you’ll use the Deliver page to set up the format, file naming convention, and organization of the media you’re outputting for editing or finishing.

Furthermore, if you need to apply a window burn, watermark, or logo to the media you’re processing, that can be accomplished using the Project panel of the Data Burn-In window, available by choosing Workspace > Data Burn-In. Window burns can be formatted with a lot of flexibility, and are written out to media that’s either rendered or output to tape. For more information, see Chapter 11, “Data Burn.”
Choosing metadata to display onscreen in the Data Burn-in window

Once you’ve selected the appropriate render settings and window burn options, you can output one or several versions of the media, to accommodate jobs where you need to provide several media deliverables. For more information on setting up and using the Deliver page, see Chapter 185, “Using the Deliver Page.”

**Step 5–Reconform Media to an EDL, AAF, or XML Project File**

Once the offline media you’ve delivered has been edited in whichever NLE is used for the project, it’s simple to reimport the edited project via an AAF, XML, or EDL file, depending on which is most suitable to your application. This edit data can be used to reconform the original media that you imported into the Media Pool, so that you immediately have access to whatever graded adjustments you made to create the offline media, as applied to the source media.

Importing AAF, XML, or EDL files in the Edit page creates new timelines, and you can import multiple subsequent Timelines to accommodate changes that have been made to the edit, if you find yourself grading a project that is in progress editorially. In fact, depending on how you set up your grades, you can use remote versions which will automatically ripple to follow each clip when you import a re-edited version of the program as a new timeline, saving you from having to recreate your work. For more information on using remote versions, see Chapter 139, “Grade Management.”

**Step 6–Output Final Media for Finishing**

Once you’re finished with your final grade, you’ll again use the controls of the Deliver page to render the program’s final media, either as individual clips for a round-trip workflow, or as a single media file or image sequence for delivery as a digital master.
Chapter 59

Conforming XML Files

XML is one of the most straightforward methods of bringing edits with as many video tracks as you need from different NLEs into DaVinci Resolve. XML import has the added benefit of allowing a variety of supported effects to be imported along with the edit data, as well as multiple tracks of video data. This chapter covers the relatively simple procedure used to import XML projects into DaVinci Resolve. This can be for a one-way trip, in which you’re finishing a project in DaVinci Resolve, or as part of a round-trip workflow, in which you return to the NLE of origin for finishing. XML round-trip workflows are fairly simple; for more information on exporting individual clips, see Chapter 186, “Rendering Media.”

Contents

More About Conforming XML Files 966
Importing XML Project Files 966
More About Conforming XML Files

DaVinci Resolve can import projects that were exported to the Final Cut Pro 7 or Final Cut Pro X XML formats. Adobe’s Premiere Pro and Autodesk Smoke and Flame Premium are also capable of using the Final Cut Pro XML project exchange format to accommodate round-trip workflows. However, for the best results you need to make sure that you’re exporting XML from Premiere Pro version 5.5.1 or newer; ideally you want to export from the latest version of Premiere Pro that’s available.

Exporting XML for use by DaVinci Resolve is straightforward, and there really aren’t any settings you need to manage when exporting an XML file other than the version of XML you want to export. For this reason, it’s best to do whatever timeline and/or media management you need to before XML export.

Manage Your Media Before Exporting an XML

In workflows using imported XML or AAF projects (or even EDLs), it’s easiest to relink and conform to the accompanying media files if they’re all located in a single directory path. Having media sorted into multiple directories is fine as long as they’re all within a single main directory that you can select at the appropriate stage of project import.

Importing XML Project Files

This section covers the Import AAF/EDL/XML dialog in much more detail. One procedure lets you accomplish any of the following workflows:

- Importing an XML file and automatically conforming to and importing the media it’s linked to.
- Importing an XML file and manually choosing another set of media, presumably in a different format or resolution, with identical metadata, to conform to instead.
- Importing an XML file that’s linked to offline media derived from a camera original format, and automatically conforming it to and importing the camera original media.

Each of these workflows is possible by choosing the correct combination of options, each of which is described in the following procedure.

To load an XML file and automatically link to its referenced media:

1. Do one of the following:
   - From any page, choose File > Import Timeline > Import AAF, EDL, XML (Shift-Command-I).
   - Open the Edit page, right-click anywhere in the Media Pool, and choose Timelines > Import > AAF/EDL/XML.

2. Using the file dialog that appears, find the project file you want to import, and click the file to open it. The Load XML window appears, depending on your selection.
Choose the options that are applicable to your particular project. By default, these options are based on metadata within the file you selected.

- **Source file**: The file you selected in the previous step.

- **Import timeline**: If there are multiple sequences within the selected XML source file, this pop-up menu lets you choose which sequence to import as a DaVinci Resolve timeline.

- **Timeline name**: The name of the Timeline you’re about to create. This defaults to the name of the sequence that was exported, but you can change it if you like.

- **Master timeline start timecode**: The timecode at which the imported timeline will start. This automatically matches the start timecode of the selected Import Timeline.

- **Automatically set project settings**: Leave this option on to automatically change the frame size and frame rate settings in the Project tab of the Config page with those in this window. You can import timelines with frame rates that are different from the Project frame rate.

- **Automatically import source clips into media pool**: Leave this checkbox on to automatically import the media referenced by the XML project file you selected into the Media Pool based on the embedded file paths. If the media files are not automatically found at these locations, you will be prompted to manually select a directory where the clips are located.

- **Ignore file extensions when matching**: Turn this checkbox on if you want to manually choose a different directory of media to link to, for example if the XML you’re importing links to ProRes Proxy media, and you want to relink to another directory of corresponding ProRes 4444 or camera raw media.

- **Use sizing information**: Lets you import position, scale, and rotation transforms from the originating NLE via the imported XML project file. These transforms are stored in each clip’s settings in the Edit page Inspector.
– Use color information: For Final Cut Pro X XML files only. This option lets you import a subset of color correction data from the Final Cut Pro X color board controls.

– Import multi-channel audio tracks as linked groups: Turn on this checkbox if you want to import multi-channel audio, such as stereo, 5.1, and 7.1 audio into individual mono timeline tracks that are linked together in the Fairlight page. For more information about Linked Groups, see Chapter 168, “Setting Up Tracks, Buses, and Patching.” If this checkbox is turned off, multi-channel audio will be imported into multi-channel audio tracks in the Timeline.

– Set timeline resolution to: Two fields let you specify the width and height of the frame size you want to work at in DaVinci Resolve. The default is whatever resolution is specified in the XML file being imported.

– Timeline frame rate: By default, this is derived from the frame rate of the XML file being imported. If you’re importing an XML file into a project that already has media in the Media Pool, the Timeline frame rate is locked and cannot be changed.

– Use drop frame timecode: By default, this is derived from the XML file being imported.

– EDL frame rate: By default, this is derived from the frame rate of the selected file.

– Use drop frame timecode: By default, this is derived from the frame rate of the selected file.

– Mixed frame rate format: This pop-up menu lets you choose the method used to conform mixed frame rates for rendering and playback. You can choose the “Final Cut Pro 7” or “Final Cut Pro X” methods of conform, while for projects imported from Media Composer, Premiere Pro, Smoke, or other NLEs, you should leave this set to “DaVinci Resolve.” This pop-up menu also appears in the Load XML dialogs when you import a project.

4 After choosing all necessary settings, click OK.

5 Assuming you left “Automatically import source clips into media pool,” turned on, if the media linked to by the XML file is not in the expected disk location, or if you turned on the “Ignore file extensions when matching” checkbox, then another dialog appears prompting you to choose the folder within which the media for this project is stored. Do one of the following:

– If you want to try to relink to media in another disk location: Click Yes, and then navigate to the folder containing your media (all subfolders will be automatically traversed as well), select it, and click OK.

– If you want to just import the Timeline with all offline clips: Click No.

A prompt appears if all the media was not found

IMPORTANT

It’s always possible to choose the top level of any volume to automatically find all media in any directories located within, but if the volume is large and full of many files, scanning every folder and document of the volume may be an extremely time-intensive process.

6 If you clicked Yes to selecting another folder, then use the folder selection dialog to navigate to another folder, and click Ok. You can cycle through this process as many times as you need to until you’ve found all the media that timeline is linked to.
Selecting the source folder for your XML imported clips

The XML file is imported. A new timeline and the referenced media files appear in the Media Pool, and the Timeline is opened so you can see its contents. Clips that could not be linked to a corresponding file on disk appear red in both the Media Pool and Timeline to indicate that they’re offline and unlinked.

**TIP:** You can open the Edit Index and choose Filter Offline Clips from the option menu to see a list of all offline clips in the current Timeline.
Chapter 60

Conforming AAF Files

AAF (Advanced Authoring Format) is a project exchange format, originally developed by the Advanced Media Workflow Association (AMWA). Commonly used video applications that export project data in the AAF format include Avid Media Composer, Avid Symphony, Autodesk Smoke and Flame Premium, and Adobe Premiere Pro.

This chapter includes detailed information about recommended workflows for moving projects from Media Composer (or Symphony) to DaVinci Resolve for grading, either as a one-way trip, or as a round-trip workflow in which you return to Avid Media Composer for finishing. Since Media Composer round-trip workflows have many variables, this is covered in depth within this chapter.

The end of this chapter also describes how to import audio projects from Pro Tools that have been exported to AAF.

Contents

Supported Media Types in AAF Workflows  971
Transcoding to DNxHD or DNxHR Always Works  971
Linking to Media Using AMA and Consolidating  971
Fast Imported Media  972
Logged Errors When Importing AAF  973
Simple AAF Import  973
Importing Boris Continuum FX with AAF Timelines  976
Performing an AAF Avid Round Trip  976
Step 1–Create a Project in Media Composer  977
Step 2–Exporting an AAF for DaVinci Resolve  977
Step 3–Conforming Your AAF in DaVinci Resolve  978
Step 4–Continue Editing, Grading, and Finishing the Project  980
Supported Media Types in AAF Workflows

Media Composer provides several methods of ingesting and managing compatible media formats. Ultimately, which formats are suitable for a Media Composer to DaVinci Resolve one-way or round trip depends on whether they’re compatible with DaVinci Resolve.

There’s one other thing to keep in mind as you’re managing media in Media Composer; not all formats are compatible with all media management operations. This combination of format compatibility and operational compatibility requires you to carefully tailor your workflow around which media files you’ll be using.

Transcoding to DNxHD or DNxHR Always Works

Since DNxHD and DNxHR were developed to be Media Composer’s core codecs, workflows where you transcode other media formats to MXF-wrapped DNxHD/DNxHR before editing will always work, and are the simplest when round tripping between Media Composer and DaVinci Resolve. DaVinci Resolve supports both MXF-wrapped and QuickTime-wrapped DNxHD/DNxHR media.

Linking to Media Using AMA and Consolidating

Avid Media Access (AMA) is a means of directly linking clips to media files in Media Composer without needing to either transcode them to DNxHD/DNxHR MXF files, or copy them to an Avid MediaFiles directory. While convenient, workflows involving media that’s linked using AMA require a bit more forethought.

Not all AMA-compatible media formats can be consolidated in Media Composer, which limits your ability to create a smaller, more portable collection of media to move into DaVinci Resolve. Whether or not an AMA-linked clip can be consolidated depends on its media format; Media Composer can only consolidate formats that it can write. For example, since Media Composer cannot write R3D media, then R3D media cannot be consolidated.

Furthermore, not all AMA-compatible media formats are compatible with DaVinci Resolve. Simply being able to edit a media format in a Media Composer timeline doesn’t guarantee you can use it in DaVinci Resolve. The following table lists which media formats can be AMA-linked in Media Composer, which formats can be consolidated, and which are compatible for use in DaVinci Resolve.
If you’re prepping a sequence that uses a mix of media formats, some of which can be consolidated, and some of which can’t, you should transcode all clips that aren’t compatible with consolidation to an Avid native codec before beginning the process of consolidating media and exporting an AAF to DaVinci Resolve.

**Fast Imported Media**

Another wrinkle is that Media Composer supports a media ingest method called “Fast Import,” where imported media is quickly copied to the Avid MediaFiles directory by inserting the original image data using the original codec into an MXF wrapper. This is an extremely fast and efficient way to bring media into Media Composer projects, but the resulting files are not typically compatible with DaVinci Resolve.

On the other hand, keep in mind that any media format that can be Fast Imported can also be consolidated. If you’re planning to round trip a sequence that uses Fast Imported media, it’s recommended that you either transcode the Fast Imported clips to DNxHD prior to AAF export, or conform your exported AAF project to the camera original media in DaVinci Resolve instead.

**TIP:** Whenever you use a combination of media in your project that includes formats that aren’t compatible with DaVinci Resolve, you can use the “Transcode Video To” checkbox in the options of the Export As dialog when exporting an AAF project. This option lets you to transcode all media that isn’t a compatible format into a format that is compatible. Some non-standard frame sizes will not transcode in Avid and will return an unsupported resolution error.

<table>
<thead>
<tr>
<th>Codec</th>
<th>Can be Natively AMA-Linked</th>
<th>Can be Consolidated</th>
<th>DaVinci Resolve Compatible</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARRI ALEXA Raw</td>
<td>Non-native support</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>AVCHD</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>AVC-Intra and Long GOP</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Blackmagic RAW</td>
<td>Non-native support</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Canon XF</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Cine (Phantom)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CinemaDNG</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>DVC PRO P2</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>QuickTime (ProRes)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>R3D (RED)</td>
<td>Non-native support</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Sony F65 Raw</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Sony HDCAM SR (SStP)</td>
<td>Non-native support</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Sony XAVC</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Sony XDCAM</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Codec**

Compatible AMA-linked formats
Logged Errors When Importing AAF

If you turn on the “Import log messages as markers” checkbox in the Load AAF dialog, certain error messages that alert you to issues with the AAF import you’re trying to do will be added as markers with notes to the Timeline. You have an option, via a pop-up embedded within the text of this checkbox, of choosing the color of the markers used to store this information.

The following messages will create markers:

- Nested edits are not supported in this release. A black clip placeholder will be inserted.
- Transition type ‘XXXX’ is not supported in this release. A Cross Dissolve will be inserted.
- Effect type ‘XXXX’ is not supported in this release. Plain clips will be imported.
- Nested layer editing is not supported in this release. The first source clip will be used.
- SMPTE Wipe Transition type ‘XXXX’ is not supported in this release. A Cross Dissolve will be inserted.
- Interpolation type ‘XXXX’ is not supported in this release. Linear interpolation will be used.
- The clip ‘XXXX’ failed to link because the timecode extents do not match any clip in the Media Pool.
- Mismatch between specified target timecodes ‘XXXX’ and located file timecodes ‘YYYY’.
- No overlap between specified target timecodes ‘XXXX’ and located file timecodes ‘YYYY’.
- Clip ‘XXXX’ in track ‘XXX’ at timecode ‘UNKNOWN’, with reel name ‘XXXX’ and filename ‘XXXX’.
- Clip ‘XXXX’ in track ‘XXX’ at timecode ‘UNKNOWN’, with reel name ‘XXXX’ and filename ‘XXXX’.
- File not found in search directories.

As of the time of this writing, this feature is only available when importing AAF files.

Simple AAF Import

This section covers the Import AAF, EDL, XML dialog in much more detail. One procedure lets you accomplish any of the following workflows:

- Importing an AAF file and automatically conforming to and importing the media it’s linked to.
- Importing an AAF file and manually choosing another set of media, presumably in a different format or resolution, with identical metadata, to conform to instead.
- Importing an AAF file that’s linked to offline media derived from a camera original format, and automatically conforming it to and importing the camera original media.

Each of these workflows is possible by choosing the correct combination of options, each of which is described in the following procedure.

To load an XML file and automatically link to its referenced media:

1. Do one of the following:

   - From any page, choose File > Import Timeline > Import AAF, EDL, XML (Shift-Command-I).
   - Open the Edit page, right-click anywhere in the Media Pool, and choose Timelines > Import > AAF/EDL/XML.
2 Using the file dialog that appears, find the project file you want to import, and click the file to open it. The Load AAF window appears, depending on your selection.

Options when importing an AAF file

3 Choose the options that are applicable to your particular project. By default, these options are based on metadata within the file you selected.

– **Source file:** The file you selected in the previous step.

– **Import timeline:** If there are multiple sequences within the selected AAF source file, this pop-up menu lets you choose which sequence to import as a DaVinci Resolve timeline.

– **Timeline name:** The name of the Timeline you’re about to create. This defaults to the name of the sequence that was exported, but you can change it if you like.

– **Master timeline start timecode:** The timecode at which the imported timeline will start. This automatically matches the start timecode of the selected Import Timeline.

– **Automatically set project settings:** Leave this option on to automatically change the frame size and frame rate settings in the Project tab of the Config page with those in this window. You can import timelines with frame rates that are different from the Project frame rate.

– **Automatically import source clips into media pool:** Leave this checkbox on to automatically import the media referenced by the AAF project file you selected into the Media Pool based on the embedded file paths. If the media files are not automatically found at these locations, you will be prompted to manually select a directory where the clips are located.

– **Ignore file extensions when matching:** Turn this checkbox on if you want to manually choose a different directory of media to link to; for example, if the AAF you’re importing links to ProRes Proxy media, and you want to relink to another directory of corresponding ProRes 4444 or camera raw media.

– **Use sizing information:** Lets you import position, scale, and rotation transforms from the originating NLE via the imported AAF project file. These transforms are stored in each clip’s settings in the Edit page Inspector.
– **Import log messages as COLOR markers:** Turn on this checkbox and choose a color from the accompanying drop-down menu for markers that will be placed in the Timeline with note text describing import errors that you might want to troubleshoot later.

– **Import multi-channel audio tracks as linked groups:** Turn on this checkbox if you want to import multi-channel audio, such as stereo, 5.1, and 7.1 audio into individual mono timeline tracks that are linked together in the Fairlight page. For more information about Linked Groups, see Chapter 168, “Setting Up Tracks, Buses, and Patching.” If this checkbox is turned off, multi-channel audio will be imported into multi-channel audio tracks in the Timeline.

– **Set timeline resolution to:** Two fields let you specify the width and height of the frame size you want to work at in DaVinci Resolve. The default is whatever resolution is specified in the AAF file being imported.

– **Timeline frame rate:** By default, this is derived from the frame rate of the AAF file being imported. If you’re importing an AAF file into a project that already has media in the Media Pool, the Timeline frame rate is locked and cannot be changed.

– **Use drop frame timecode:** By default, this is derived from the AAF file being imported.

– **EDL frame rate:** By default, this is derived from the frame rate of the selected file.

– **Use drop frame timecode:** By default, this is derived from the frame rate of the selected file.

– **Mixed frame rate format:** This drop-down menu lets you choose the method used to conform mixed frame rates for rendering and playback. You can choose the “Final Cut Pro 7” or “Final Cut Pro X” methods of conform, while for projects imported from Media Composer, Premiere Pro, Smoke, or other NLEs, you should leave this set to “DaVinci Resolve.” This drop-down menu also appears in the Load AAF dialogs when you import a project.

4 After choosing all necessary settings, click OK.

5 Assuming you left “Automatically import source clips into media pool,” turned on, if the media linked to by the AAF file is not in the expected disk location, or if you turned on the “Ignore file extensions when matching” checkbox, then another dialog appears prompting you to choose the folder within which the media for this project is stored. Do one of the following:

– **If you want to try to relink to media in another disk location:** Click Yes, and then navigate to the folder containing your media (all subfolders will be automatically traversed as well), select it, and click OK.

– **If you want to just import the Timeline with all offline clips:** Click No.

A prompt appears if all the media was not found

**IMPORTANT**

It’s always possible to choose the top level of any volume to automatically find all media in any directories located within, but if the volume is large and full of many files, scanning every folder and document of the volume may be an extremely time-intensive process.
6 If you clicked Yes to selecting another folder, then use the folder selection dialog to navigate to another folder, and click Ok. You can cycle through this process as many times as you need to until you’ve found all the media that timeline is linked to.

Selecting the source folder for your AAF imported clips

The AAF file is imported. A new timeline and the referenced media files appear in the Media Pool, and the Timeline is opened so you can see its contents. Clips that could not be linked to a corresponding file on disk appear red in both the Media Pool and Timeline to indicate that they’re offline and unlinked.

TIP: You can open the Edit Index and choose Filter Offline Clips from the option menu to see a list of all offline clips in the current Timeline.

Importing Boris Continuum FX with AAF Timelines

Boris Continuum FX effects and settings will be imported along with a timeline via AAF export. You’ll need to have the same Continuum suite of effects installed on both machines (OFX version for DaVinci Resolve, AVX for Avid). When importing an AAF, Boris Continuum effects that were used in the original NLE will appear on each affected clip in the resulting DaVinci Resolve timeline, with all previously applied parameters available in the Inspector. The Sapphire and Mocha suites are not available for AAF import at this time.

Performing an AAF Avid Round Trip

This section outlines a comprehensive workflow for creating projects in Media Composer that will be compatible with DaVinci Resolve, moving projects from Media Composer to DaVinci Resolve, then grading, rendering, and sending the final graded project back to Media Composer. The following steps include procedures covering the following tasks:
– Ingesting all media as high quality MXF-wrapped DNxHD, then round tripping from Media Composer to DaVinci Resolve.

– Importing and editing Resolve-compatible AMA-linked media formats, then round tripping from Media Composer to DaVinci Resolve.

– Transcoding AMA-linked media files into offline-quality DNxHD clips for editing, then exporting an AAF file and reconforming it in DaVinci Resolve to high quality camera original media as part of the round trip.

Because there are so many variations in the way that Media Composer can ingest media and output AAF projects, you should familiarize yourself with the following procedures before continuing with your own project.

Step 1–Create a Project in Media Composer

1 When creating a project in Media Composer, take note of the image format details, as these should be matched in DaVinci Resolve. In particular, set the image format (e.g., 1080p/24) and raster dimensions (e.g., 1920x1080) to match your desired mastering format. Also, color space should be set to RGB 709 if you’re planning to send ingested/transcoded media from Media Composer to DaVinci Resolve for grading.

**NOTE:** This information can also be found in the Avid Project Format tab.

2 Open your project, and ingest all necessary media into a new bin using one or both of the following methods:

– **Transcode media for editing:** The simplest workflow for AAF import and round-trip workflows is to ingest transcoded, native MXF-wrapped DNxHD media using the Import command.

– **Import AMA-linked clips:** You can also import AMA-linked clips, so long as all AMA-linked files are in a format that’s compatible with DaVinci Resolve. Keep in mind that not all AMA-compatible formats can be consolidated in Media Composer. In this case, import AMA-linked media into a new bin using the Link to AMA File(s) command, and edit as usual.

Once you’ve ingested all necessary media, you can edit your project as you would any other, keeping in mind which effects are compatible with DaVinci Resolve. For more information on effects in Media Composer to DaVinci Resolve round trips, see Chapter 56, “Preparing Timelines for Import and Comparison.”

Step 2–Exporting an AAF for DaVinci Resolve

When you’re finished editing, you need to export an AAF that will conform the .mxf media you used in Media Composer into a DaVinci Resolve timeline. Two export configuration options are available, depending on whether DaVinci Resolve and Media Composer are on the same system.

1 Select the sequence you want to export, and choose File > Output > Export to File.

2 In the Export As dialog, type a name for the AAF file you’ll be exporting.

3 Choose a location to save the AAF. You can save it anywhere you like, but if you’re moving the project to another workstation, you may want to save it to a specific folder on a removable hard drive where you store your AAF and XML files. The location you choose can also be used as the location of the media that’s exported to accompany the AAF.
Click the Options button to open a more detailed window of export settings.

Turn on the AAF Edit Protocol checkbox. This option forces Media Composer to export a simplified AAF file that’s more compatible with the project exchange workflows of different applications.

Choose the appropriate option from the Export Method pop-up menu to configure how the AAF and its accompanying media will be exported. The option you choose depends on the following:

- **If Media Composer and DaVinci Resolve are on the same system:** Choose “Link to (Don’t Export) Media” to export an AAF file that links to the existing media in its current location. Click the Audio Details tab and choose “Link to (Don’t Export) Media” from the Export Method pop-up menu.

- **If Media Composer and DaVinci Resolve are on different systems:** Choose one of the two following export methods:
  - **Copy All Media:** For each source clip used, the entire corresponding media file is copied. This can be useful when you want to preserve the original relationship of each clip to the source media file it came from. However, be aware that you’ll potentially be exporting a lot of media when you use this option.
  - **Consolidate Media:** This is a more efficient media management workflow for finished projects, since unused media will not be copied. You can specify additional handles to add to the beginning and end of each exported media file, in frames, in the Handle Length field. Should any media file and its handles overlap another media file and its handles, both will be combined into a single exported media file.

(Optional) If you’re using a combination of media in your project that includes formats that aren’t compatible with DaVinci Resolve, you can optionally turn on the “Transcode Video To” checkbox and choose a media format from the pop-up menu to the right. This option automatically transcodes all media in your sequence that doesn’t match the format specified in the pop-up to match that format.

If you’re copying or consolidating media to another drive, choose “Folder” from the Media Destinations Video/Data pop-up menu. Turn on the “Use Same Folder As AAF File” checkbox to save the exported media to the same folder you selected in step 3. If you leave this checkbox turned off, you can click Select Folder to choose another location.

Click Save, and when you return to the Export As dialog, click Save again.

Once export is complete, you’ll see a duplicate sequence and duplicate media populating your Media Composer bin, with the suffix “.Exported” appended to the sequence, and “.new” appended to each media clip. In the file system, the resulting folder contains an AAF file, and an Avid MediaFiles folder that contains the exported media.

**Step 3—Conforming Your AAF in DaVinci Resolve**

Open DaVinci Resolve and create a new project.

Before you do anything else, you need to set DaVinci Resolve to properly read the timecode and reel number information from the AAF files that Media Composer creates. Click the gear button at the lower right-hand side of the DaVinci Resolve window to open the Project Settings window, click General Options to reveal the Conform Options, and do the following:

- Make sure that “Use Timecode” is set to "Embedded in the source clip."
- Turn the “Assist using reel names from the” checkbox on, and choose “Embedding in source clip file.”
3 Click Save.

4 Do one of the following:
   – From any page, choose File > Import AAF, EDL, XML (Shift-Command-I).
   – Open the Edit page, right-click anywhere in the Media Pool, and choose Timelines > Import > AAF/EDL/XML.

5 When the File Selection window opens, select the AAF file you exported from Media Composer, and click Open.

6 When the Load AAF dialog appears, the settings you choose determine which media files the AAF will be conformed to:

   ![Load AAF window conform options](https://via.placeholder.com/150)

   – **To conform to the transcoded or AMA-linked media files you edited:** Leave the “Automatically import source clips into media pool” checkbox turned on.

   – **To conform to a different set of camera original media files:** Turn on both the “Automatically import source clips into media pool” and “Link to source camera files” checkboxes, which references the Source Name metadata that Media Composer/Symphony embeds in exported AAF files to track the correspondence in file naming between transcoded and camera original media.

   – **To conform to a directory of media of your choosing:** Turn on both the “Automatically import source clips into media pool” and “Ignore file extensions when matching” checkboxes.

   – **To conform to media that’s already in the Media Pool:** Turn off the “Automatically import source clips into media pool” checkbox. There must be clips in the Media Pool for this to work.

7 Additionally, make sure that the “Automatically set project settings” checkbox is on.
There are three other options that are relevant to AAF import:

- **Use Sizing Information**: (Optional) Use this checkbox if you want to import position, scale, and rotate transform data from the originating Media Composer project into DaVinci Resolve.

- **Import log messages as COLOR markers**: Turn on this checkbox and choose a color from the accompanying drop-down menu for markers that will be placed in the Timeline with note text describing import errors that you might want to troubleshoot later.

- **Import multi-channel audio tracks as linked groups**: Turn on this checkbox if you want to import multi-channel audio, such as stereo, 5.1, and 7.1 audio into individual mono timeline tracks that are linked together in the Fairlight page. For more information about Linked Groups, see Chapter 168, “Setting Up Tracks, Buses, and Patching.” If this checkbox is turned off, multi-channel audio will be imported into multi-channel audio tracks in the Timeline.

Click OK.

As long as the media remains where it was when you exported it from Media Composer, the timeline and all its media should now import. However, if the location of the media files you’re conforming to has changed, then you may need to identify the location of the media via an additional dialog. For example, if you’ve copied the media from the portable hard drive it was originally conform to, to a faster storage volume, then a file dialog appears, requesting that you choose the folder containing the media used by your project. If prompted, do so and click OK.

Once import is complete, the Media Pool fills with the source media used by the imported project, and the edit appears as the current Timeline in the Edit page.

### Step 4—Continue Editing, Grading, and Finishing the Project

Edit the Timeline in the Edit page and grade each clip in the Color page as you would any other. However, you should be aware that if you use the tools found in the Edit page to make any editorial changes to the timeline you’ve imported, your export options will change later on:

- **If you don’t make editing changes**: Then you have the option to have DaVinci Resolve use the Avid AAF file that you originally imported to generate an updated one. This preserves audio and all other unsupported effects from the original AAF file, so that they reappear when you export a new AAF back to Media Composer. If you use this option, you need to make sure the original AAF file you import remains in the same location.

- **If you do make editing changes**: Then you need to use the “Generate New AAF” command to export an AAF of the re-edited Timeline from DaVinci Resolve back to Media Composer. This newly generated AAF file will not include any effects that are not supported by DaVinci Resolve.
Step 5—Render Graded Media and Export a New AAF

1. When you’re ready to send a graded project back to Media Composer, select the Timeline you graded and open the Deliver page.

2. Choose “Avid AAF” from the Presets at the top of the Render Settings to load its settings.

3. In the Format section, choose the MXF codec you want to render to.

4. In the File section, choose the appropriate file destination path for the rendered media. The location you choose depends on whether Media Composer and DaVinci Resolve are on the same computer or not.
   - If Media Composer and DaVinci Resolve are on the same computer: Create a new folder within your Avid MediaFiles folder (Avid MediaFiles/MXF/) named with a number. Make sure you choose a previously unused number.
   - If DaVinci Resolve is on a different computer using different storage: Select any directory on the portable hard drive you’ll be using to bring the media back to the Media Composer workstation from which it came.

5. If you require handles for your rendered output, you can add handles in the Advanced Settings of the Video tab. When making any changes to the File render settings, make sure to leave the “Render Clip with Unique Filename” checkbox turned on to ensure that each clip rendered has a different file name as multiple clips in the edited sequence may originate from the same source clip.

6. In the Timeline, click Select Entire Timeline to select the entire Timeline for delivery, and then click Add to Render Queue at the bottom of the Render Settings to add the job you’ve set up to the Render Queue.

7. Click Start Render at the bottom of the Render Queue to initiate rendering.

The project renders, and an AAF is automatically exported to the same directory as the media you’ve rendered.

Step 6—Copy the Graded Media to Avid MediaFiles

1. For workflows where DaVinci Resolve and Media Composer are on separate workstations, locate the media directory containing the media files that were rendered out of DaVinci Resolve on the portable hard drive being used to transport the project back to your Avid workstation, and copy it into the Avid MediaFiles/MXF/ directory.

2. Rename the directory to be a number. Make sure you choose an unused number.
Step 7–Import the Graded AAF

1 Reopen the original project in Media Composer. If the media in the new directory of the Avid MediaFiles folder is in a compatible format, it will automatically be added to the internal database of media.

2 Create a new bin to contain the graded sequence you’re about to import.

3 Open the new bin, then choose File > Input > Import Media, select the graded AAF file that you exported from DaVinci Resolve, and click Open.

4 As long as the media is available in the Avid MediaFiles directory, the new bin you’ve created should automatically fill up with the clips that were rendered out of DaVinci Resolve, and a new sequence should appear.

5 Double click the sequence you’ve imported to open it into the Record monitor and Timeline, fully conformed with the color corrected clips from DaVinci Resolve. This sequence is now ready for finishing in Media Composer.

Relinking Transcoded Media to AMA Media

This next workflow is useful when you’ve been editing transcoded, offline versions of processor- or bandwidth-intensive media, but you want to send the original high-quality source media (such as ALEXA or RED raw files) to DaVinci Resolve for grading. In certain situations, it may be better to reconform your sequence to the original AMA-linked media files in Media Composer before you round trip from Media Composer to DaVinci Resolve.

Step 1–Relink Your Transcoded Media to AMA-Linked Source

1 Edit a sequence using media that you’ve transcoded within Media Composer.

2 When you’re finished, open the bin that contains your project’s camera original media, and select the AMA-linked clips that correspond to the transcoded clips you’ve been editing.

3 Right-click the edited sequence in its bin, and choose Relink from the contextual menu.

4 When the Relink dialog appears, turn on “Select items in ALL open bins.” Select “Tape Name or Source File Name” under the Source Name settings, and leave the “Create new sequence” checkbox turned on.

A new sequence is created that is now linked to the AMA-linked camera originals.

Step 2–Export an AAF File

1 Select the new sequence that was created, and choose File > Output > Export to File.

2 Type a new name, choose a location for the file, and click Options.

3 Choose AAF from the Export As pop-up menu, and choose “Link to (Don’t Export) Media” from the Export Method pop-up menu.

4 Click Audio Details, and choose “Link to (Don’t Export) Media” from the Export Method pop-up menu.

5 Click Save to exit the Export Settings dialog, and then click Save again to export the file.
Step 3–Import the AAF, Grade, Render, and Export

1. Open DaVinci Resolve, and import the AAF file you exported into the Edit page. You’ll need to manually select the media in a second dialog.

2. Grade the project as you would any other.

3. When you’re done grading, use the AAF Round Trip option in the Deliver page to render the graded media into a new (numbered) directory in the Avid MediaFiles directory.

4. Open the Edit page, select the original AAF timeline you imported, right-click it, and choose Export AAF/XML. Pick a location for the file and click Save.

Step 4–Reimport the AAF into Media Composer/Symphony

Open Media Composer, and import the AAF you exported from DaVinci Resolve. Your graded sequence is now ready for finishing.

Audio AAF Import from Pro Tools

Importing audio AAF timelines from Pro Tools (or any DAW software capable of exporting AAF) works similarly to the workflow for importing a video AAF from Media Composer that’s detailed at the beginning of this chapter. However, there are two methods you can use.

Import AAF, EDL, XML

Using the File > Import Timeline > Import AAF, EDL, XML command (Command-Shift-I), you can select a Pro Tools AAF. You’re presented with all the same import options as a Media Composer AAF, but what you end up with is an audio-only timeline, to which you can add a reference video if you need to.

Import AAF to Current Timeline

Using the File > Import Timeline > Import AAF to Current Timeline command lets you import an audio AAF to the currently open timeline. When you use this command, the import dialog presents similar import options, however, there are two additional options to choose from.

The “Import AAF to current timeline” checkbox is on, and presents two options:

– **Insert Additional Tracks**: Lets you import the audio tracks starting at the beginning of the current timeline, placing them underneath the lowest track with existing audio in the Timeline.

– **Insert with offset**: Lets you import the audio tracks with a specified offset from the beginning of the Timeline.
Chapter 61

Conforming EDL Files

The edit decision list (EDL) is the lowest common denominator project exchange format there is, and most professional post-production applications are capable of exporting and importing projects in this format, including Media Composer, Autodesk Flame Premium, and the legacy Final Cut Pro 7. This chapter covers all workflows that let you import and conform timelines using the EDL format.

Contents

Conforming EDL Files 985
EDL Export of a Project and Its Media 986
Conforming EDLs to Individual Media Files 986
Preconforming “Flat” Media Files to EDLs 987
Override Input Color Space of Clips in Preconform Workflows Using Color Management 988
Conforming “Flat” Media Files Using Split and Add 988
Importing an EDL to a New Track 989
Conforming EDL Files

DaVinci Resolve supports the CMX 3600 format for EDL import and export. The universality of EDLs is due, in part, to their longevity; different EDL formats have been in use for decades. It's also due to their simplicity. At least as used by DaVinci Resolve, EDLs describe a very narrow range of editorial information, including clip arrangement, clip name (via embedded comments), video transitions (cuts or dissolves), and linear speed settings (percentage of fast forward or slow motion).

Another limitation is that EDLs only support a sequence of shots on a single video track. If you need to move projects with multiple tracks of audio and video, then you can export each track as a separate EDL from the originating application, and then right-click the timeline you want to import them into in the Media Pool and use the Timelines > Import > EDL to New Track contextual menu command to import each separate EDL to a new track of a single timeline in DaVinci Resolve. This is described later in this chapter.

**NOTE:** While the EDL format supports a variety of SMPTE-defined video transition codes, all EDL transitions are turned into cross dissolves of identical duration in DaVinci Resolve.

If you're not familiar with the EDL format, each edit appears as a numbered event that contains the reel number, edit type, source timecode (In and Out points), and record timecode (In and Out points). Here's a sample of a simple four event EDL:

**TITLE:** Pool Shark Edit

**FCM:** NON–DROP FRAME

<table>
<thead>
<tr>
<th>Event</th>
<th>Reel</th>
<th>Type</th>
<th>Source Timecode</th>
<th>Record Timecode</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>REEL.ONE</td>
<td>AA/V</td>
<td>C</td>
<td>10:59:23:01 10:59:28:16</td>
</tr>
<tr>
<td>002</td>
<td>REEL.ONE</td>
<td>AA/V</td>
<td>C</td>
<td>11:39:48:15 11:39:51:13</td>
</tr>
<tr>
<td>003</td>
<td>REEL.ONE</td>
<td>AA/V</td>
<td>C</td>
<td>13:16:30:21 13:16:34:19</td>
</tr>
<tr>
<td>004</td>
<td>REEL.ONE</td>
<td>AA/V</td>
<td>C</td>
<td>14:09:43:16 14:09:44:20</td>
</tr>
</tbody>
</table>

Since DaVinci Resolve was originally designed to work by importing and exporting EDLs, there are several methods you can use to import projects using EDLs. In all cases, you must first add the media referenced by that EDL to the Media Pool before you can import its EDL.

The three primary workflows are:

- **Conforming EDLs to individual media files:** Importing an EDL that references a collection of discrete media files that have already been imported into DaVinci Resolve.

- **Preconforming, or “notching,” a “flattened” master media file using an EDL:** Importing an EDL that references a “flattened” master media file. Flattened master media files are created when an entire sequence is exported from an NLE as a single self-contained media file.

- **Importing an EDL directly to a new track of an existing edit:** If you’re importing a multi-track video project, and the only means of doing so is using EDLs, you can export each track of the source project as an individual EDL, and then import each EDL into DaVinci Resolve directly into additional tracks of the same Timeline. This is also useful for workflows where effects clips are being managed on a separate track assembled elsewhere, that you can then import directly into a graded timeline to place many new effects clips all at once.

This description covers the different ways that EDLs can be used in DaVinci Resolve.
EDL Export of a Project and Its Media

When using EDL workflows, it’s important to make sure that every clip in your edited sequence, and every source media file it’s linked to, has an appropriate reel number/reel name, and true timecode written into that file. When conforming EDLs, DaVinci Resolve requires reel names and accurate timecode to successfully conform the imported EDL timeline to media in the Media Pool.

To export an EDL that can be easily conformed by DaVinci Resolve, each NLE has particular settings that you should use. The primary supported format is CMX 3600, although DaVinci Resolve also supports the DEDL format exported by both Smoke and Flame. Also, most editing applications let you choose which video and audio tracks you want to export, and how to handle the start timecode for the selected sequence of clips you’re exporting. In general, it’s a good idea to make sure that the exported start timecode matches that of your sequence timeline.

There are other details, however, that vary by application. For example, when exporting an EDL from Media Composer using Tools > List Tool, you need to make sure that the Active Setting is set to Default EDL, and that the Output Format is set to CMX_3600. When exporting an EDL from Premiere Pro, you have the option of enabling Use Source File Name and Include Transitions. When exporting an EDL from the legacy Final Cut Pro 7, you need to make sure you set Reel Conflicts to Generic Edits, and turn on the File Names checkbox. Most applications provide other settings that are optional, including EDL notes of various kinds, but for a cleaner, easier to read EDL, you can turn these off if you like.

Conforming EDLs to Individual Media Files

The advantage of working with discrete media files is that they are the “purest” version of the media, without any effects (such as dissolves or superimpositions) “baked” into the visuals that might create complications when you’re grading.

1. Before you import any media, make sure that the “Timeline frame rate” pop-up menu in the Master Settings panel of the Project Settings is set to a frame rate that matches your project and media. Otherwise, the EDL’s timecode will be misinterpreted.

2. Open the Media page, use the Media Storage browser to locate the media you want to add to the project, and add it to the Media Pool by right-clicking the enclosing directory and choosing one of the following commands:
   - **Add Folder into Media Pool**: Adds all compatible media files within that folder to the Media Pool. Subfolders are not traversed.
   - **Add Folder and SubFolders into Media Pool**: Adds all compatible media files from that folder, and all subfolders within that folder, to the Media Pool.
   - **Add Folder Based on EDLs into Media Pool**: Prompts you to choose an EDL. Only media referenced by that EDL is imported, and only the selected folder is searched for that media.
   - **Add Folder and SubFolders Based on EDLs into Media Pool**: Prompts you to choose an EDL. Only media referenced by that EDL is imported, and the selected folder and all subfolders are searched for that media.

   **TIP**: The “Add Folder...Based on EDLs” commands are useful for efficiently adding just the media you need to the Media Pool in instances where there might be many terabytes of unmanaged source media, most of which is unused.
3. Do one of the following:
   - From any page, choose File > Import AAF, EDL, XML (Command-Shift-I).
   - Right-click anywhere in the background of the Media Pool, and choose Timelines > Import > AAF/EDL/XML.
   
   A window appears prompting you to “Select a file to import.”

4. Navigate to the EDL file you want to use, select it, and click Open. The Load EDL window appears.

5. Choose the options that are applicable to your particular project. All greyed out options are not editable, either because they’re not applicable, or are not defined by the Project Settings that are currently applied. The options you can set include:
   - **Source File**: The file you selected in the previous step.
   - **Timeline name**: The name of the Timeline you’re about to create. This defaults to the name of the EDL file you selected, but you can change this if you like, for example, to add the import date if this is a new version of the edit.
   - **Automatically set project settings checkbox**: Turn this option on if you want to overwrite the frame size setting in the Master Project Settings panel of the Project Settings. You cannot overwrite the Timeline frame rate when importing an EDL.
   - **Set timeline resolution to**: Two fields let you specify the width and height of the frame size you want to work at in DaVinci Resolve. This defaults to your Project settings, but can be overridden by turning on the “Automatically set project settings” checkbox.
   - **EDL framerate**: Choose the frame rate of the sequence that you exported as an EDL. You can use this option to convert the EDL frame rate from 30 to 24 frames per second if you set the Timeline frame rate to 24 fps and if the EDL frame rate is set to 30 fps; this is useful when an offline edit is done at 30 fps with media using 3:2 pulldown. Note that 25 fps to 24 fps conversion is not supported.
   - **Use drop frame timecode checkbox**: Only enabled if the EDL frame rate pop-up menu is set to 30 fps. Turn this on if your EDL uses drop-frame timecode.

6. When you’re finished choosing options, click OK.

   The EDL is imported, a new timeline appears highlighted in the Media Pool, and its corresponding sequence of clips appears in the Timeline Editor if you’re in the Edit page. Clips that could not be linked to a corresponding file in the Media Pool appear with a red thumbnail to indicate that they’re unconformed.

---

**Preconforming “Flat” Media Files to EDLs**

Preparing an edited sequence for grading, along with each individual clip of media, can be time consuming for effects-intensive projects, or it may be an unnecessary step for a project with no effects whatsoever.

In these cases, it can be simpler and quicker to export a flattened master media file that can be split back apart into its individual clips in DaVinci Resolve. This workflow is similar to a more traditional tape-to-tape workflow, except that you’re working from a digital master, rather than a tape-based master.

The easiest way to do this is to use the Preconform button in the Edit page to split a single master file that you’ve imported into the Media Pool back into individual clips in a new timeline.
To preconform a flattened master media file to an EDL:

1. Open the Media page, use the Media Storage browser to navigate to the flattened master media file that you exported containing the entire program, and double-click to add it to the Media Pool.

2. Right-click anywhere in the background of the Media Pool, and choose Timelines > Import > Preconformed EDL.

3. In the “Select an EDL file” dialog that appears, navigate to the EDL that matches the flattened master media file you had exported, select it, and click Open.

4. In the “Parse preconform options” dialog that appears, give the new Timeline a name, and click OK.

A new Timeline appears in the Media Pool list, and opening it in the Edit page shows the flattened media file with edits added to its video track that correspond to those from the selected EDL, ready for further editing and grading. The audio is left uncut, on the premise that you’re probably focused on grading the visuals in this workflow, and not on re-editing the audio.

Override Input Color Space of Clips in Preconform Workflows Using Color Management

When you preconform a flattened master media file using an EDL with the File > Import Timeline > Pre-conformed EDL command, and your project has Resolve Color Management or ACES enabled, you can now change the Input Color Space of each clip in the resulting Timeline independently. To do so, open the Color page, right-click the clips you want to customize, and choose an option from the Input Color Space submenu of the contextual menu.

This is useful in workflows where you’ve received a flattened media file that was output with clips in different color spaces, for example mixing Rec. 709 media with log-encoded clips of different kinds.

Conforming “Flat” Media Files Using Split and Add

The second method of conforming an EDL to a flattened file is to use the “Split and Add” command in the Media page to split one or more master media files into individual clips that match those of an EDL, then importing the EDL itself in the Edit page in a second step.

This method is useful if there are clips in different folders or volumes that you want to conform to a single EDL. For example, the majority of the first reel of a program may have been exported as a single flattened file, but the corresponding EDL may require that an additional folder of effects clips be added to the Media Pool to be fully conformed.

To split a flat media file in the Media page and import its EDL in the Edit page:

1. Before you import any media, make sure that the “Timeline frame rate” pop-up menu in the Master Settings panel of the Project Settings is set to a frame rate that matches your project.

2. Open the Media page, use the Media Storage browser to navigate to the flattened master media file that contains the entire program.

3. Select the flattened media file, right-click it, and choose “Split and Add into Media Pool.”

4. In the “Select EDL files for splitting clips” dialog that appears, navigate to the EDL that matches the flattened master media file, select it, and click Open.
5 Select the frame rate of the project from the File Conform Frame Rate dialog that appears. This frame rate should be identical to the “Timeline frame rate” pop-up you set in step 1.

6 Choose the appropriate options in the “Enter handle size for splitting” dialog that appears:
   – **Handle size in number of frames:** Enter a number of frames to be added as handles to the first and last frame of the clip. This is useful when you’re using the “Split and Add into Media Pool” command to import only the referenced sections of a directory of individual media files.
   – **Split Unreferred Clips:** Useful when the referenced media files include segments that aren’t “referred to” by any events within the EDL used to split them. Turning this checkbox on adds all such unreferred clip segments to the Media Pool as separate clips, for possible later use.

7 Click Split & Add. The Media Pool fills up with individual segments of the flattened master media file, each of which matches an event in the EDL you used to split it.

8 To import the corresponding EDL to create a timeline with this media, do one of the following:
   – From any page, choose File > Import AAF, EDL, XML (Shift-Command-I).
   – Right-click anywhere in the background of the Media Pool, and choose Timelines > Import > AAF/EDL/XML.

9 In the “Choose a file to import” dialog that appears, navigate to the EDL that matches the flattened master media file, select it, and click Open.

10 Choose whatever options are necessary from the Load EDL dialog that appears (the default settings should work fine), and click OK.

The Master Timeline and the timeline you just imported appear in the Media Pool, the Conform EDL list updates with the events from the imported EDL, and the Timeline editor shows the edited clips, ready for grading. Clips that could not be linked to a corresponding file in the Media Pool appear with a red x to indicate that they’re unconformed.

### Importing an EDL to a New Track

This last procedure describes how to add an EDL, not as an individual new Timeline, but as an additional video track to an existing Timeline. There are many reasons you might want to do this. For example, if you need to move a multi-track project to DaVinci Resolve from an application that can’t export either AAF or XML project exchange files that DaVinci Resolve understands, you can use multiple EDLs. Simply export each track of the source project as an individual EDL, and then import each EDL into DaVinci Resolve as additional tracks of the same Timeline.

This is also useful for workflows where effects clips are being managed on a separate track assembled elsewhere, that you can then import directly into a graded Timeline to place many new effects clips all at once.

**To import an EDL to a new track of an existing timeline:**

1 In this procedure, you have the option of adding whatever media is required by the EDL you’re about to import to the Media Pool first, or you can add the media after the EDL has been imported. It’s your choice.

2 Open the Edit page, select a timeline in the Media Pool, then right-click it and choose Timelines > Import > EDL to New Track. A window appears prompting you to “Choose a file to import.”

3 Navigate to the EDL file you want to use, select it, and click Open.

4 A new video track is created above any previously existing tracks, and events from the selected EDL are immediately loaded into it according to their record timecode positions. If you loaded the media needed by the new clips at the beginning of this procedure, that media should be conformed. Otherwise, you’ll need to track down the media files needed by the new unconformed clips and add it to the Media Pool now.
Chapter 62

Introduction to Compositing in Fusion

This introduction is designed explicitly to help users who are new to Fusion get started learning this exceptionally powerful environment for creating and editing visual effects and motion graphics right from within DaVinci Resolve or using the stand-alone Fusion Studio application.

This documentation covers both the Fusion Page inside DaVinci Resolve and the stand-alone Fusion Studio application.

Contents

What Is Fusion? 992
The Fusion Page within DaVinci Resolve 992
The Fusion Studio Stand-Alone Application 993
What Kinds of Effects Does Fusion Offer? 994
How Hard Will This Be to Learn? 995
What Is Fusion?

Blackmagic Design Fusion is powerful 2D and 3D visual effects compositing software with over thirty years of evolution serving the motion picture and broadcast industry, creating effects seen in countless films and television series. It is available as a stand-alone application as well as a page within DaVinci Resolve.

In its purest form, Fusion is a collection of image-processing engines called nodes. These nodes represent effects like blurs and color correctors, as well as images, 3D models, and spline masks. Similar to effects you may be familiar with, each node includes a set of parameters that can be adjusted and animated over time. Stringing different nodes together in a graphical user interface called a node tree allows you to create sophisticated visual effects. The nodes, node trees, and all settings you create are saved in a document called a Composition, or "comp" for short.

The Fusion Page within DaVinci Resolve

Merged right into DaVinci Resolve, the Fusion page makes it possible to jump immediately from editing right into compositing, with no need to export media, relink files, or launch another application to get your work done. Now everything you need lives right inside DaVinci Resolve.

How Do I Use the Fusion Page?

The relationship between the Edit page and the Fusion page is similar to the relationship between the Edit page and the Color page. Each clip can have a grade applied to it in the Color page, and similarly every clip can have a composition applied to it in the Fusion page.

If you use the Fusion page to create any kind of effect or composite, a badge appears on that clip in the Timeline to show that clip has a composition applied to it.
To create an effect in the Fusion page of DaVinci Resolve, you need only park the playhead over a clip in the Edit or Cut page and then click the Fusion page button. Your clip is immediately available as a MediaIn node in the Fusion page, ready for you to add a variety of stylistic effects. You can paint out an unwanted blemish or feature, build a quick composite to add graphics or text, or accomplish any other visual effect you can imagine, built from the Fusion page’s toolkit of effects.

Alternatively, in DaVinci Resolve, you have the option of editing together all the clips you want to use, superimposing and lining up every piece of media you’ll need with the correct timing, before selecting them and creating a Fusion clip. A Fusion clip functions as a single item in the Edit or Cut page timeline, but once in the Fusion page, each piece of media you’ve assembled is revealed in a fully built Fusion composition, ready for you to start adding nodes to customize for whatever effect you need to create.

Whichever way you want to work, all this happens on the very same timeline as editing, grading, and audio post, for a seamless back and forth as you edit, refine, and finish your projects.

How Do Fusion Effects Differ from Edit Page Effects?
When using DaVinci Resolve, you can create numerous effects in the Edit page. Transitions, fades, superimpositions, over-the-shoulder picture-in-picture effects, time remapping, and lower third titles are some of the effects that can be quickly and more efficiently created in the Edit or Cut page timeline. However, the Fusion page’s node-based interface lets you go deep into the details of a composition to create sophisticated 2D and 3D effects with precise control and endless customization. Effects that include more than two or three layers can be much more manageable in Fusion. Green or blue screen composites, sky replacements, and object removal are all effects better suited for Fusion’s more advanced toolset.

How Do Fusion Effects Differ from Color Page Effects?
The Color page in DaVinci Resolve can also handle some visual effects work. Effects that blur the line between color grading and finishing can be very fast and intuitive in the Color Page, especially for people already familiar with the Color page toolset. Beauty work and small image repairs can make efficient use of the Color page’s straightforward Tracking tool, Face Refinement, and Patch Replacer effects. However, when it comes to more challenging blue/green screen compositing, the tools built around Fusion’s powerful Delta keyer are more capable of handling these shots. Integrating 3D objects into live-action scenes, split-screen effects, motion graphics, and precise keyframing are all better suited to the Fusion page.

The Fusion Studio Stand-Alone Application
Creating visual effects with the stand-alone Fusion Studio software begins with opening Fusion, creating a new composition, importing some clips via Loader nodes, and building out your composite with effects. Just like the Fusion Page in DaVinci Resolve, you add effects using different nodes from the Effects Library, and you combine multiple layers of imagery using Merge nodes. Once you’ve created the desired result, add a Saver node to the end of the tree of nodes you’ve created to render your final result.

Rendering Out Your Final Result
Unlike the Fusion Page in DaVinci Resolve, which renders directly back into the Edit or Cut page timeline, the final step in Fusion Studio is to render the finished effect to disk as a movie file or image sequence. The last node in every node tree is a Saver node. Saver nodes configure the output file format and render the file to disk. You can use as many Saver nodes in a composite as you need. For instance, you might use multiple Saver nodes to render out intermediate areas of a composite or to output a composite in multiple formats.
What Kinds of Effects Does Fusion Offer?

In addition to the kinds of robust compositing, paint, rotoscoping, and keying effects you’d expect from a fully-featured 2D compositing environment, Fusion offers much more.

3D Compositing

Fusion has powerful 3D nodes that include extruded 3D text, simple geometry, and the ability to import 3D models. Once you’ve assembled a 3D scene, you can add cameras, lighting, and material shaders, and then render the result with depth-of-field effects and auxiliary channels to integrate with more conventional layers of 2D compositing, for a sophisticated blending of 3D and 2D operations in the very same node tree.

Particles

Fusion also has an extensive set of nodes for creating particle systems that have been used in major motion pictures, with particle generators capable of spawning other generators, 3D particle generation, complex simulation behaviors that interact with 3D objects, and endless options for experimentation and customization. You can create particle system simulations for VFX or more abstract particle effects for motion graphics.
The Text tools in Fusion are exceptional, giving you layout and animation options in both 2D and 3D. Furthermore, within DaVinci Resolve, these Text tools have been incorporated into the Edit and Cut pages as Fusion Titles. These title templates are compositions saved from Fusion as macros with published controls that are visible in the Edit or Cut page Inspector for easy customization, even if you’re working with people who don’t know Fusion.

A multi-layered text composite integrating video clips and Fusion-generated elements

And Lots More

The list goes on. With Stereo and VR adjustment nodes, Planar Tracking, Deep Pixel nodes for re-compositing rendered 3D scenes using Auxiliary Channel data, powerful Masking and Rotoscoping nodes, and Warping effects, Fusion is an impressively featured environment for building worlds, fixing problems, and flying multi-layered motion graphics animations through your programs.

How Hard Will This Be to Learn?

That depends on what you want to do, but honestly it’s not so bad with this PDF at your side, helping guide the way. It’s worth repeating that this Fusion documentation was developed specifically to help users who’ve never before worked with Fusion learn the core concepts needed to perform the basics, in preparation for learning the rest of the application on your own.

Fusion is a deep, production-driven product that’s had decades of development, so its feature set is deep and comprehensive. You won’t learn it in an hour, but much of what you’ll find won’t be so very different from other compositing applications you may have used. And if you’ve familiarized yourself with the node-based grading workflow of the DaVinci Resolve Color page, you’ve already got a leg up on understanding the central operational concept of compositing in Fusion.
Chapter 63

Exploring the Fusion Interface

This chapter provides an orientation on the Fusion user interface, providing a quick tour of what tools are available, where to find things, and how the different panels fit together to help you build and refine compositions in this powerful node-based environment.

Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Fusion User Interface</td>
<td>998</td>
</tr>
<tr>
<td>The Work Area</td>
<td>999</td>
</tr>
<tr>
<td>Interface Toolbar</td>
<td>999</td>
</tr>
<tr>
<td>Choosing Which Panel Has Focus</td>
<td>1000</td>
</tr>
<tr>
<td>Viewers</td>
<td>1000</td>
</tr>
<tr>
<td>Zooming and Panning into Viewers</td>
<td>1002</td>
</tr>
<tr>
<td>Loading Nodes Into Viewers</td>
<td>1002</td>
</tr>
<tr>
<td>Clearing Viewers</td>
<td>1003</td>
</tr>
<tr>
<td>Viewer Controls</td>
<td>1003</td>
</tr>
<tr>
<td>Time Ruler and Transport Controls</td>
<td>1005</td>
</tr>
<tr>
<td>Time Ruler Controls in the Fusion Page</td>
<td>1005</td>
</tr>
<tr>
<td>Time Ruler Controls in Fusion Studio</td>
<td>1006</td>
</tr>
<tr>
<td>The Playhead</td>
<td>1006</td>
</tr>
<tr>
<td>Zoom and Scroll Bar</td>
<td>1007</td>
</tr>
<tr>
<td>Transport Controls in the Fusion Page</td>
<td>1007</td>
</tr>
<tr>
<td>Audio Monitoring</td>
<td>1009</td>
</tr>
<tr>
<td>Transport Controls in Fusion Studio</td>
<td>1010</td>
</tr>
<tr>
<td>Changing the Time Display Format</td>
<td>1014</td>
</tr>
<tr>
<td>Keyframe Display in the Time Ruler</td>
<td>1014</td>
</tr>
<tr>
<td>The Fusion RAM Cache for Playback</td>
<td>1014</td>
</tr>
</tbody>
</table>
The Fusion User Interface

If you open up everything at once, Fusion is divided into four principal regions designed to help you make fast work of node-based compositing. The viewer(s) are at the top, the work area is at the bottom, the Inspector is at the right, and the Effects Library is the area found at the left. In DaVinci Resolve’s Fusion page, the Effects Library shares space with the Media Pool. All these panels work together to let you add effects, paint to correct issues, create motion graphics or title sequences, or build sophisticated 3D and multi-layered composites.

However, Fusion doesn’t have to be that complicated, and in truth, you can work very nicely with only the viewer, Node Editor, and Inspector open for a simplified experience.
The Work Area

You probably won’t see the term “the work area” used much, in favor of the specific panels within the work area that you’ll be using. Still, the area referred to as the work area is the region at the bottom half of the Fusion user interface, within which you can expose the three main panels used to construct compositions and edit animations in Fusion. These are the Node Editor, the Spline Editor, and the Keyframes Editor. By default, the Node Editor is the first thing you’ll see, and the main area you’ll be working within, but it can sit side-by-side with the Spline Editor and Keyframes Editor as necessary. You can make more horizontal room on your display for these three panels by putting the Effects Library and Inspector into a half-height mode, if necessary.

Interface Toolbar

At the very top of Fusion is a toolbar with buttons that let you show and hide different parts of the user interface (UI). Buttons with labels identify which parts of the UI can be shown or hidden. In DaVinci Resolve’s Fusion page, if you right-click anywhere within this toolbar, you have the option of displaying this bar with or without text labels.

These buttons are as follows, from left to right:

- **Media Pool/Effects Library Full Height**: Lets you set the area used by the Media Pool (DaVinci Resolve only) and/or Effects Library to take up the full height of your display, giving you more area for browsing at the expense of a narrower Node Editor and viewer area. At half-height, the Media Pool/Templates/Effects Library are restricted to the top half of the UI along with the viewers (you can only show one at a time), and the Node Editor takes up the full width of your display.

- **Media Pool** (DaVinci Resolve only): Shows and hides the Media Pool, from which you can drag additional clips into the Node Editor to use them in your Fusion page composition.

- **Effects Library**: Opens or hides the repository of all node tools available to use in Fusion. From here, you can click nodes to add them after the currently selected node in the Node Editor, or you can drag and drop nodes to any part of the node tree you like.

- **Clips** (DaVinci Resolve only): Opens and closes the Thumbnail timeline, which lets you navigate your program, create and manage multiple versions of compositions, and reset the current composition.

- **Nodes**: Opens and closes the Node Editor, where you build and edit your compositions.
– **Console (Fusion Studio only):** The Console is a window in which you can see the error, log, script, and input messages that may explain something Fusion is trying to do in greater detail. The Console is also where you can read FusionScript outputs, or input FusionScripts directly.

– **Spline:** Opens and closes the Spline Editor, where you can edit the curves that interpolate keyframe animations to customize and perfect their timing. Each keyframed parameter appears hierarchically within the effect in which it appears in a list to the left.

– **Keyframes:** Opens and closes the Keyframes Editor, which shows each clip and effects node in your Fusion composition as a layer. You can use the Keyframes Editor to edit and adjust the timing of keyframes that have been added to various effects in your composition. You can also use the Keyframes Editor to slide the relative timing of clips that have been added to Fusion, as well as to trim their In and Out points. A spreadsheet can be shown and hidden within which you can numerically edit keyframe values for selected effects.

– **Metadata (DaVinci Resolve only):** Hides or shows the Metadata Editor, which lets you read and edit the available clip and project metadata associated with any piece of media within a composite.

– **Inspector:** Shows or hides the Inspector, which shows you all the editable parameters and controls that correspond to selected nodes in the Node Editor. You can show the parameters for multiple nodes at once, and even pin the parameters of nodes you need to continue editing so that they’re displayed even if those nodes aren’t selected.

– **Inspector Height:** Lets you open the Inspector to be half height (the height of the viewer area) or full height (the height of your entire display). Half height allows more room for the Node Editor, Spline Editor, and/or Keyframes Editor, but full height lets you simultaneously edit more node parameters or have enough room to display the parameters of multiple nodes at once.

### Choosing Which Panel Has Focus

Whenever you click somewhere on the Fusion interface using the pointer or using a keyboard shortcut to “select” a particular panel, you give that panel of the user interface “focus.” A panel with focus captures specific keyboard shortcuts to do something within that panel, as opposed to doing something elsewhere in the interface.

To make it easier to keep track of which panel has focus, a highlight appears at the top edge of whichever panel has focus. In DaVinci Resolve, you must turn on “Show focus indicators in the User Interface” in the UI Settings panel of the User Preferences to see the highlight.

![The focus indicator shown at the top edge of the Media Pool, shown next to a viewer that doesn’t have focus](image)

### Viewers

The viewer area displays either one or two viewers at the top of the Fusion page, and this is determined via the Viewer button at the far right of the Viewer title bar. Each viewer can show a single node’s output from anywhere in the node tree. You assign which node is displayed in which viewer. This makes it easy to load separate nodes into each viewer for comparison. For example, you can load a Keyer node into the left viewer and the final composite into the right viewer, so you can see the image you’re adjusting and the final result at the same time.
Dual viewers let you edit an upstream node in one while seeing its effect on the overall composition in the other.

Ordinarily, each viewer shows 2D nodes from your composition as a single image. However, when you’re viewing a 3D node, you have the option to set that viewer to one of several 3D views. A perspective view gives you a repositionable stage on which to arrange the elements of the world you’re creating. Alternatively, a quad view lets you see your composition from four angles, making it easier to arrange and edit objects and layers within the XYZ axes of the 3D space in which you’re working.

**TIP:** In Perspective view, you can hold down the Option key and drag in the viewer to pivot the view around the center of the world. All other methods of navigating viewers work the same.

The viewers have a variety of capabilities you can use to compare and evaluate images. This section provides a short overview of viewer capabilities to get you started.
Zooming and Panning into Viewers

There are standardized methods of zooming into and panning around viewers when you need a closer look at the situation. These methods also work with the Node Editor, Spline Editor, and Keyframes Editor.

Methods of panning viewers:
- Middle-click and drag to pan around the viewer.
- Hold down Shift and Command and drag the viewer to pan.
- Drag with two fingers on a track pad to pan.

Methods of scaling viewers:
- Click a viewer, and press the equals key (=) to zoom in, and the minus key (-) to zoom out.
- Press the middle and left mouse buttons simultaneously and drag left or right to resize the viewer.
- Hold down the Command key and use your pointer’s scroll control to zoom in and out of the viewer.
- Hold down the middle mouse button, and then click the left mouse button to zoom in, or click the right button to zoom out. The scaling uses a fixed amount, centered on the position of the cursor.
- Click a viewer and press Command-1 to resize the image in the viewer to 100 percent.
- Click a viewer and press Command-F to reset the image in the viewer to fit the viewer.
- Click the Scale viewer menu and choose Fit or a percentage.
- Right-click on a viewer and choose an option from the Scale submenu of the contextual menu. This includes a Custom Scale command that lets you type your own scale percentage.
- Hold down the Command key and drag with two fingers on a track pad to zoom in and out of the viewer.

Methods of spinning 3D viewers:
- In 3D Perspective view, hold down the Shift key and drag to spin the stage around.
- In 3D Perspective view, hold down the Shift key and drag with two fingers on a track pad to spin the stage around.

Loading Nodes Into Viewers

When you first open the Fusion page in DaVinci Resolve, the output of the current empty composition (the MediaOut1 node) is usually showing in viewer 2. If you’re in Dual-viewer mode, viewer 1 remains empty until you assign a node to one of them.

When using Fusion Studio, nothing is loaded into either of the viewers until you assign a node to one of them.

To load specific nodes into specific viewers:
- Hover the pointer over a node, and click one of two buttons that appear at the bottom left of the node.
- Click once to select a node, and press 1 (for the left viewer) or 2 (for the right viewer).
- Right-click a node and choose View On > None/Left View/Right View in the contextual menu.
- Right-click the control header of a node in the Inspector, and choose View On > None/Left View/Right View from the contextual menu.
- Drag a node and drop it over the viewer you’d like to load it into (this is great for tablet users).
When a node is being viewed, a View Indicator button appears at the bottom left. This is the same control that appears when you hover the pointer over a node. Not only does this control let you know which nodes are loaded into which viewer, but they also expose little round buttons for switching between viewers.

Clearing Viewers

To clear an image from a viewer, click in the viewer to make it active; a thin red highlight is displayed at the top of the active viewer. With the viewer active, press the Tilde (’‘) key. This key is usually found to the left of the 1 key on U.S. keyboards. The fastest way to remove all the images from all the viewers is to make sure none of the viewers is the active panel, and then press the Tilde key.

Viewer Controls

A series of buttons and pop-up menus in the viewer’s title bar provides several quick ways of customizing the viewer display.

– **Zoom menu:** Lets you zoom in on the image in the viewer to get a closer look, or zoom out to get more room around the edges of the frame for rotoscoping or positioning different layers. Choose **Fit** to automatically fit the overall image to the available dimensions of the viewer.

– **Split Wipe button and A/B Buffer menu:** You can actually load two nodes into a single viewer using that viewer’s A/B buffers by choosing a buffer from the menu and loading a node into the viewer. Turning on the Split Wipe button (press Forward Slash) shows a split wipe between the two buffers, which can be dragged left or right via the handle of the onscreen control, or rotated by dragging anywhere on the dividing line on the onscreen control. Alternatively, you can switch between each full-screen buffer to compare them (or to dismiss a split-screen) by pressing Comma (A buffer) and Period (B buffer).

– **SubView type:** (These aren’t available in 3D viewers.) Clicking the icon itself enables or disables the current “SubView” option you’ve selected, while using the menu lets you choose which SubView is enabled. This menu serves one of two purposes. When displaying ordinary 2D nodes, it lets you open up SubViews, which are viewer “accessories” within a little pane that can be used to evaluate images in different ways. These include an Image Navigator (for navigating when zoomed far into an image), Magnifier, 2D viewer (a mini-view of the image), 3D Histogram scope, Color Inspector, Histogram scope, Image Info tooltip, Metadata tooltip, Vectorscope, or Waveform scope. The Swap option (Shift-V) lets you switch what’s displayed in the viewer with what’s being displayed in the Accessory pane. When displaying 3D nodes, this button lets you turn on the quad-paned 3D viewer.

– **Node name:** The name of the currently viewed node is displayed at the center of the viewer’s title bar.
**RoI controls:** Clicking the icon itself enables or disables RoI (Region of Interest) limiting in the viewer, while using the menu lets you choose the region of the RoI. RoI lets you define the region of the viewer in which pixels actually need to be updated. When a node renders, it intersects the current RoI with the current Domain of Definition (DoD) to determine what pixels should be affected. When enabled, you can position a rectangle to restrict rendering to a small region of the image, which can significantly speed up performance when you’re working on very high resolution or complex compositions. Auto (the default) sets the region to whatever is visible at the current zoom/pan level in the viewer. Choosing Set lets you draw a custom region within the frame by dragging a rectangle that defaults to the size of the viewer, which is resizable by dragging the corners or sides of the onscreen control. Choosing Lock prevents changes from being made to the current RoI. Choosing Reset resets the RoI to the whole viewer.

**Color controls:** Lets you choose which color and/or image channels to display in the viewer. Clicking the icon itself toggles between Color (RGB) and Alpha, the two most common things you want to see (pressing C or A also toggles between Color and Alpha). Opening the menu displays every possible channel that can be displayed for the currently viewed node, commonly including RGB, Red, Green, Blue, and Alpha (available from the keyboard by pressing R, G, B, or A). For certain media and nodes, additional auxiliary channels are available to be viewed, including Z-depth, Object ID, Material ID, XYZ Normals, and so on.

**Viewer LUT:** Clicking the icon itself toggles LUT (LookUp Table) display on or off, while the menu lets you choose which of the many available color space conversions to apply to the viewer. The top five options let you choose Fusion controls that can be customized via the Edit item at the bottom of this menu. The rest of this menu shows all LUTs installed in the LUT directory to use for viewing.

By default, when using DaVinci Resolve, the viewers in the Fusion page show you the image prior to any grading done in the Color page, since the Fusion page comes before the Color page in the DaVinci Resolve image processing pipeline. When you’re working on clips that have been converted to linear color space for compositing, it is desirable to composite and make adjustments to the image relative to a normalized version of the image that appears close to what the final will be. Enabling the LUT display lets you do this as a preview, without permanently applying color adjustments to the image.

**Option menu:** This menu contains various settings that pertain to the viewers in Fusion.

- **Snap to Pixel:** When drawing or adjusting a polyline mask or spline, the control points will snap to pixel locations.
- **Show Controls:** Toggles whatever onscreen controls are visible for the currently selected node.
- **Region:** Provides all the settings for the Region of Interest in the viewer.
- **Smooth Resize:** This option uses a smoother bilinear interpolated resizing method when zooming into an image in the viewer; otherwise, scaling uses the nearest neighbor method and shows noticeable aliasing artifacts. However, this is more useful when you zoom in at a pixel level since there is no interpolation.
- **Show Square Pixels:** Overrides the auto aspect correction when using formats with non-square pixels.
- **Normalized Color Range:** Allows for the visualization of brightness values outside of the normal viewing range, particularly when working with floating-point images or auxiliary channels.
- **Checker Underlay:** Toggles a checkerboard underlay that makes it easy to see areas of transparency.
- **Gain/Gamma:** Exposes a simple pair of Gain and Gamma sliders that let you adjust the viewer’s brightness.
- **360 View:** Used to properly display spherical imagery in a variety of formats, selectable from this submenu.
- **Stereo:** Used to properly display stereoscopic imagery in a variety of formats, selectable from this submenu.
Time Ruler and Transport Controls

The Time Ruler, located beneath the viewer area, is based on the total duration of the composition. What it represents depends on which version of Fusion you’re using:

– For DaVinci Resolve users, the duration displayed in the Time Ruler range depends on what’s currently selected in the Edit or Cut page timeline.
– In Fusion Studio, the Time Ruler depends on the Global Start and End values set in the Fusion Studio Preferences > Defaults.

The transport controls under the Time Ruler include playback controls, audio monitoring, as well as number fields for the composition duration and playback range. Additional controls enable motion blur and proxy settings.

Time Ruler Controls in the Fusion Page

If you’ve selected a single clip in the Edit or Cut page Timeline, then the global range shown in the Time Ruler is based on the total source duration for that clip. You cannot move the playhead outside the global range. The yellow lines, called the render range, identify the current In and Out points for the clip and are the only frames visible in the Fusion page. All frames outside of this range constitute the unused head and tail handles of that source clip.

The Time Ruler displaying ranges for a clip in the Timeline via yellow marks (the playhead is red)

If you’ve created a Fusion clip or a compound clip, then the “working range” reflects the entire duration of that clip.

The Time Ruler displaying ranges for a Fusion clip in the Timeline

Render Range

The render range determines the range of frames that are visible in the Fusion page and that are used for interactive playback, disk caches, and previews. Frames outside the default render range are not visible in the Fusion page and are not rendered or played.

You can modify the duration of the render range for preview and playback only. Making the range shorter or longer does not trim the clip in the Edit or Cut page Timelines.

You can change the render range in the Time Ruler by doing one of the following:

– Hold down the Command key and drag a new range within the Time Ruler.
– Drag either the start or end yellow line to modify the start or end of the range.
– Right-click within the Time Ruler and choose Set Render Range from the contextual menu.
– Enter new ranges in the Range In and Out fields to the left of the transport controls.
– Drag a node from the Node Editor to the Time Ruler to set the range to the duration of that node.
You can return the render range to the In and Out points of the timeline clip by doing one of the following.

- Right-click within the Time Ruler and choose Auto Render Range.
- Click back in the Edit or Cut page, and then return to the Fusion page.

### Time Ruler Controls in Fusion Studio

The Time Ruler, located beneath the viewer area, displays two different frame ranges: one for the entire composition, called the global range, and the other called the render range, which determines what to render and what to cache in memory for previews. The global start and end range takes up the entire Time Ruler and sets the total duration of a composition. You cannot move the playhead outside the global range.

#### Global Start and End Range

The global start and end range is simply the total duration of the current composition.

**You can change the global range by doing one of the following:**

- To change the global range for all new compositions, choose Fusion Studio > Preferences on macOS or File > Preferences on Windows or Linux. In the Global and Default Settings panel, enter a new range in the Global range fields.
- To change the Global range for the current composition, enter a new range in the Global Start and End fields to the left of the transport controls.
- Dragging a node from the Node Editor to the Time Ruler automatically sets the Global and Render Range to the extent of the node.

#### Render Range

The render range determines the range of frames used for interactive playback, disk caches, and previews. Frames outside the render range are not rendered or played, although you can still drag the playhead to these frames to see the unused frames.

To preview or render a specific range of a composition, you can modify the render range in a variety of ways.

**You can set the render range in the Time Ruler by doing one of the following:**

- Hold down the Command key and drag a new range within the Time Ruler.
- Right-click within the Time Ruler and choose Set Render Range from the contextual menu to set the Render Range based on the selected Node’s duration.
- Enter new ranges in the Range In and Out fields to the left of the transport controls.
- Drag a node from the Node Editor to the Time Ruler to set the range to the duration of that node.

### The Playhead

A red playhead within the Time Ruler indicates the currently viewed frame. Clicking anywhere within the Time Ruler jumps the playhead to that frame, and dragging within the Time Ruler drags the playhead within the available duration of that clip or composition.
Zoom and Scroll Bar
A two-handled gray scroll bar lets you zoom into the range shown by the Time Ruler, which is useful if you’re using a very large Global range such that the Render range is a tiny sliver in the Time Ruler. Dragging the left or right handles of this bar zooms relative to the opposite handle, enlarging the width of each displayed frame. Once you’ve zoomed in, you can drag the scroll bar left or right to scroll through the composition.

**TIP:** Holding the middle mouse button and dragging in the Time Ruler lets you scroll the visible range.

Transport Controls in the Fusion Page
The Transport Controls in DaVinci Resolve’s Fusion page include buttons that control playback as well as time fields on the left side for setting the render range and the current time on the right side. Additional controls are available in the right-click menu.

Controlling Playback
There are six transport controls underneath the Time Ruler in the Fusion page. These buttons include Composition First Frame, Play Reverse, Stop, Play Forward, Composition Last Frame, and Loop.

Navigation Shortcuts
Many standard transport control keyboard shortcuts you may be familiar with work in Fusion, but some are specific to Fusion’s particular needs.

**To move the playhead in the Time Ruler using the keyboard, do one of the following:**
- **Spacebar:** Toggles forward playback on and off.
- **JKL:** Basic JKL playback is supported, including J to play backward, K to stop, and L to play forward.
- **Back Arrow:** Moves 1 frame backward.
- **Forward Arrow:** Moves 1 frame forward.
- **Shift-Back Arrow:** Moves to the clip’s Global End frame.
- **Shift-Forward Arrow:** Moves to the clip’s Global Start frame.
- **Command-Back Arrow:** Jumps to the Render Range In point.
- **Command-Forward Arrow:** Jumps to the Render Range Out point.

Real-Time Playback Not Guaranteed
Because many of the effects you can create in the Fusion page are processor-intensive, there is no guarantee of real-time playback at your project’s full frame rate unless you’ve cached your composition first (discussed later).
Frame Increment Options
Right-clicking either the Play Reverse or Play Forward buttons opens a contextual menu. This menu contains options to set a frame increment value, which lets you use a keyboard shortcut to move the playhead in sub-frame or multi-frame increments.

Moving the playhead in multi-frame increments can be useful when rotoscoping. Moving the playhead in sub-frame increments can be useful when rotoscoping or inspecting interlaced frames one field at a time (0.5 of a frame).

Looping Options
The Loop button can be toggled to enable or disable looping during playback. You can right-click this button to choose the looping method that’s used:

- **Playback Loop**: The playhead plays to the end of the Time Ruler and starts from the beginning again.
- **Ping-pong Loop**: When the playhead reaches the end of the Time Ruler, playback reverses until the playhead reaches the beginning of the Time Ruler, and then continues to ping-pong back and forth.

Render Range Fields
The two time fields on the left side of the transport controls are used to modify the Render Range. You can enter time values in frames to modify the In and Out of the render range for previews and caching.
Audio Monitoring

Playing a composition in DaVinci Resolve’s Fusion page will play the audio from the Edit or Cut page Timeline. You can choose to hear the audio or mute it using the Audio toolbar button to the left of the transport controls. The audio waveforms are displayed in the Keyframes Editor to assist in the timing of your animations.

**TIP:** If the Mute button is enabled on any Timeline tracks, audio from those tracks will not be heard in Fusion.

For Fusion Studio, audio can be loaded using the Loader node’s Audio tab. The audio functionality is included in Fusion Studio for scratch track (aligning effects to audio and clip timing) purposes. Final renders should almost always be performed without audio. Audio can be heard if it is brought in through a Loader node.

**To hear the audio from a specific Loader node:**
- Right-click over the Speaker icon and choose the file name that contains the audio you want to hear.

Audio Toolbar Button

The Audio button in the toolbar is a toggle that can be used to enable or mute audio playback associated with the clip. Additionally, right-clicking this button displays a contextual menu that can be used to select a MediaIn node in the Fusion page or an external WAV file in Fusion Studio.

The Current Time Field

The Current Time field at the right of the transport controls displays the frame number for the playhead position, which corresponds to the frame seen in the viewer. However, you can also enter time values into this field to move the playhead by specific amounts.

When setting ranges and entering frame numbers to move to a specific frame, numbers can be entered in sub-frame increments. You can set a range to be –145.6 to 451.75 or set the playhead to 115.22. This can be very helpful when animating parameters because you can set keyframes where they actually need to occur, rather than on a frame boundary, so you get more natural animation. Having sub-frame time lets you use time remapping nodes or just scale keyframes in the Spline view and maintain precision.

The Fusion Page Viewer Quality and Proxy Options

Right-clicking anywhere in the transport control area other than over the Play Forward/Play Reverse buttons lets you turn on and off Fusion quality controls. You can either enable high-quality playback at the expense of more significant processing times or enter various proxy modes that temporarily lower the display quality of your composition to speed processing as you work.

Rendering for final output is always done at the highest quality, regardless of these settings.

**High Quality**

As you build a composition, often the quality of the displayed image is less important than the speed at which you can work. The High Quality setting gives you the option to either display images with faster interactivity or at final render quality. When you turn off High Quality, complex and time-consuming operations such as area sampling, anti-aliasing, and interpolation are skipped to render the image to the viewer more quickly. Enabling High Quality forces a full-quality render to the viewer that’s identical to what is output during final delivery.
Motion Blur
The Motion Blur button is a global setting. Turning off Motion Blur temporarily disables motion blur throughout the composition, regardless of any individual nodes for which it’s enabled. This can significantly speed up renders to the viewer. Individual nodes must first have motion blur enabled before this button has any effect.

Proxy
The Proxy setting is a draft mode used to speed processing while you’re building your composite. Turning on Proxy reduces the resolution of the images that are rendered to the viewer, speeding render times by causing only one out of every x pixels to be processed, rather than processing every pixel. The value of x is decided by adjusting a slider in the General panel of the Fusion Settings, found in the Fusion menu.

Auto Proxy
The Auto Proxy setting is a draft mode used to speed processing while you’re building your composite. Turning on Auto Proxy reduces the resolution of the image while you click and drag to adjust a parameter. Once you release that control, the image snaps back to its original resolution. This lets you adjust processor-intensive operations more smoothly, without the wait for every frame to render at full quality causing jerkiness. You can set the auto proxy ratio by adjusting a slider in the General panel of the Fusion Settings found in the Fusion menu.

Selective Updates
When working in Fusion, only the tools needed to display the images in the viewer are updated. The Selective Update options select the mode used during previews and final renders.

The options are available in the Fusion Preferences General panel. The three options are:

– **Update All (All):** Forces all the nodes in the current node tree to render. This is primarily used when you want to update all the thumbnails displayed in the Node Editor.

– **Selective (Some):** Causes only nodes that directly contribute to the current image to be rendered. So named because only selective nodes are rendered. This is the default setting.

– **No Update (None):** Prevents rendering altogether, which can be handy for making many changes to a slow-to-render composition.

Transport Controls in Fusion Studio
The transport controls in Fusion Studio include buttons to control playback, time fields on the left side for setting the global range and render range, and a Render button to initiate rendering of the composite. There are also controls on the right side for proxy and motion blur. The time field on the far right is used for the current time.

Controlling Playback
There are eight transport controls underneath the Time Ruler in Fusion Studio. These buttons include Composition First Frame, Step Backward, Play Reverse, Stop, Play Forward, Step Forward, Composition Last Frame, and Loop.
Navigation Shortcuts

Many standard transport control keyboard shortcuts you may be familiar with work in Fusion, but there are some keyboard shortcuts specific to Fusion’s particular needs.

To move the playhead in the Time Ruler using the keyboard, do one of the following:

– **Spacebar**: Toggles forward playback on and off.
– **JKL**: Basic JKL playback is supported, including J to play backward, K to stop, and L to play forward.
– **Back Arrow**: Moves 1 frame backward.
– **Forward Arrow**: Moves 1 frame forward.
– **Shift-Back Arrow**: Moves to the clip’s Global End frame.
– **Shift-Forward Arrow**: Moves to the clip’s Global Start frame.
– **Command-Back Arrow**: Jumps to the Render Range In point.
– **Command-Forward Arrow**: Jumps to the Render Range Out point.

Real-Time Playback Not Guaranteed

Because many of the effects you can create in the Fusion page are processor-intensive, there is no guarantee of real-time playback at your project’s full frame rate, unless you’ve cached your composition first. For more information, see the “Fusion RAM Cache for Playback” section later in this chapter.

Frame Increment Options

Right-clicking the Step Backward, Play Reverse, Play Forward, or Step Forward buttons opens a drop-down menu with options to set a frame increment value. Selecting a frame number from the menu lets you move the playhead in sub-frame or multi-frame increments whenever you use a keyboard shortcut or press the Step Forward/Backward buttons.

Moving the playhead in multi-frame increments can be useful when rotoscoping. Moving the playhead in sub-frame increments can be useful when rotoscoping or inspecting interlaced frames one field at a time (0.5 of a frame).
Looping Options
The Loop button can be toggled to enable or disable looping during playback. You can right-click this button to choose the looping method that’s used:

- **Playback Loop:** The playhead plays to the end of the Time Ruler and starts from the beginning again.
- **Ping-pong Loop:** When the playhead reaches the end of the Time Ruler, playback reverses until the playhead reaches the beginning of the Time Ruler, and then continues to ping-pong back and forth.

Range Fields
The four time fields on the left side of the transport controls are used to quickly modify the global range and render range in Fusion Studio.

Audio
The Audio button is a toggle that mutes or enables any audio associated with the clip. Additionally, right-clicking on this button displays a drop-down menu that can be used to select a WAV file, which can be played along with the composition, and to assign an offset to the audio playback.

Render
Clicking the Render button in the transport controls displays the composition’s Render Settings dialog. This dialog is used to configure the render options and initiate rendering of any Saver nodes in the composition. Shift-clicking on the button skips the dialog, using default render values (full resolution, high quality, motion blur enabled).

The Current Time
The Current Time field at the right of the transport controls shows the frame at the position of the playhead, which corresponds to the frame seen in the viewer. However, you can also enter time values into this field to move the playhead by specific amounts.

When setting ranges and entering frame numbers to move to a specific frame, numbers can be entered in sub-frame increments. You can set a range to be -145.6 to 451.75 or set the playhead to 115.22. This can be very helpful when animating parameters because you can set keyframes where they actually need to occur, rather than on a frame boundary, so you get more natural animation.

Having sub-frame time lets you use time remapping nodes or just scale keyframes in the Spline view and maintain precision.

**NOTE:** Many fields in Fusion can evaluate mathematical expressions that you type into them. For example, typing 2 + 4 into most fields results in the value 6.0 being entered. Because Feet + Frames uses the + symbol as a separator symbol rather than a mathematical symbol, the Current Time field will not correctly evaluate mathematical expressions that use the + symbol, even when the display format is set to Frames mode.

Fusion Studio Viewer Quality and Proxy Options
Five buttons along the right side of the transport controls let you either enable high-quality playback at the expense of greater processing times, or enter various proxy modes that temporarily lower the display quality in order to speed processing as you work.
Rendering for final output is always done at the highest quality, regardless of these settings.

Five buttons control the viewer quality, motion blur, proxy options, and image-processing update settings.

**HiQ**
As you build a composition, often the quality of the displayed image is less important than the speed at which you can work. The High Quality setting gives you the option to either display images with faster interactivity or at final render quality. When you turn off High Quality, complex and time-consuming operations such as area sampling, anti-aliasing, and interpolation are skipped to render the image to the viewer more quickly. Enabling High Quality forces a full-quality render to the viewer that’s identical to what will be output during final delivery.

**MB**
The Motion Blur button is a global setting. Turning off Motion Blur temporarily disables motion blur throughout the composition, regardless of any individual nodes for which it’s enabled. This can significantly speed up renders to the viewer. Individual nodes must first have motion blur enabled before this button has any effect.

**Prx**
A draft mode to speed processing while you’re building your composite. Turning on Proxy reduces the resolution of the images that are rendered to the viewer, speeding render times by causing only one out of every x pixels to be processed, rather than processing every pixel. The value of x is decided by adjusting a slider in the General panel of the Fusion Preferences, found under the Fusion menu on macOS or the File menu on Windows and Linux.

**Aprx**
A draft mode to speed processing while you’re building your composite. Turning on Auto Proxy reduces the resolution of the image while you click and drag to adjust a parameter. Once you release that control, the image snaps back to its original resolution. This lets you adjust processor-intensive operations more smoothly, without the wait for every frame to render at full quality causing jerkiness. You can set the auto proxy ratio by adjusting a slider in the General panel of the Fusion Preferences, found under the Fusion menu on macOS or the File menu on Windows and Linux.

**Selective Updates**
The last of the five buttons on the right of the transport controls is a three-way toggle that determines when nodes update images in the viewer. By default, when working in Fusion, any node needed to display the image in the viewer is updated. The Selective Update button can change this behavior during previews and final renders.

The three options are:

- **Update All (All):** Forces all the nodes in the current node tree to render. This is primarily used when you want to update all the thumbnails displayed in the Node Editor.
- **Selective (Some):** Causes only nodes that directly contribute to the current image to be rendered. So named because only selective nodes are rendered. This is the default setting.
- **No Update (None):** Prevents rendering altogether, which can be handy for making a lot of changes to a slow-to-render composition.

The options are also available in the Fusion Preferences General panel.
Changing the Time Display Format

By default, all time fields and markers in Fusion count in frames, but you can also set the time display to SMPTE timecode or Feet + Frames.

To change the time display format:

1. Choose Fusion > Fusion Settings in DaVinci Resolve, choose Fusion Studio > Preferences in Fusion Studio on macOS, or choose File > Preferences in Fusion Studio on Windows or Linux.

2. When the Fusion settings dialog opens, select the Global and Default settings > Defaults panel and choose a Timecode option.

3. Select the Frame Format panel. If you’re using timecode, choose a frame rate and turn on the “has fields” checkbox if your project is interlaced. If you’re using feet and frames, set the Film Size value to match the number of frames found in a foot of film in the format used in your project.

4. Click Save.

Keyframe Display in the Time Ruler

When you select a node with keyframed parameters, those keyframes appear in the Time Ruler as little white tic marks, letting you navigate among and edit keyframes without having to open the Keyframes Editor or Spline Editor to see them.

The Time Ruler displaying keyframe marks

To move the playhead in the Time Ruler among keyframes:

- Press Option-Left Bracket ([) to jump to the next keyframe to the left.
- Press Option-Right Bracket (]) to jump to the next keyframe to the right.

The Fusion RAM Cache for Playback

When assembling a node tree, all image processing operations are rendered live to display the final result in the viewers. However, as each frame is rendered, and especially as you initiate playback forward or backward, these images are automatically stored to a RAM cache as they’re processed so you can replay those frames in real time. The actual frame rate achieved during playback is displayed in the Status bar at the bottom of the Fusion window during playback. Of course, when you play beyond the cached area of the Time Ruler, uncached frames need to be rendered before being added to the cache.

Priority is given to caching nodes that are currently being displayed, based on which nodes are loaded to which viewers. However, other nodes may also be cached, depending on available memory and on how processor-intensive those nodes happen to be, among other factors.

Memory Limits of the RAM Cache

There is a single setting in DaVinci Resolve for limiting the RAM used for caching. This setting is located in the DaVinci Resolve Preferences Memory and GPU panel.

- **Limit Fusion Memory Cache To:** This slider sets the maximum amount of RAM that Fusion can access for caching. It is a subset of the RAM allocated to DaVinci Resolve. You can assign a maximum of 75% to Fusion from DaVinci Resolve’s total RAM allocation. When not using the Fusion page, the RAM is released for other pages in DaVinci Resolve.
There are two settings in Fusion Studio for limiting the RAM used for caching. These settings are located in the Preferences Memory panel.

- **Limit Caching To:** This slider sets the maximum amount of RAM used for caching. The 60% default setting on a 32-GB system limits the cache to 19.2 GB. The maximum amount you can assign to Fusion Studio is limited to 80% of the total system memory. This leaves a minimum amount of memory for other applications and the operating system.

- **Leave at least # MBytes:** This number field further limits caching in cases where the system's available free RAM drops below the entered value. For instance, setting this to 200 MB attempts to keep 200 MB of RAM free for the OS or other applications. Setting the number field to 0 allows Fusion Studio to use the full amount of RAM specified by the Limit Caching To setting, ignoring other apps.

When the size of the cache reaches the Fusion Caching/Memory Limits setting found in the Memory panel of the Preferences, then lower-priority cache frames are automatically discarded to make room for new caching. You can keep track of the RAM cache usage via a percentage indicator on the far right of the Status bar at the bottom of the Fusion window.

### Displaying Cached Frames
All cached frames for the currently viewed node are indicated by a green line at the bottom of the Time Ruler. Any green section of the Time Ruler should play back in real time.

The green lines indicate frames that have been cached for playback.

### Temporarily Preserving the Cache When Changing Quality or Proxy Settings
If you toggle the composition’s quality settings or proxy options, the cache is not immediately discarded. The green line instead turns red to let you know the cache is being preserved and can be used again when you go back to the original level of quality or disable proxy mode. However, if you play through those frames at the new quality or proxy settings, this preserved cache is overwritten with a new cache at the current quality or proxy setting.

A red line indicates that cached frames from a different quality or proxy setting are being preserved.

There’s one exception to this, however. When you cache frames at the High Quality setting, and you then turn off High Quality, the green frames won’t turn red. Instead, the High Quality cached frames are used even though the HiQ setting has been disabled.
The toolbar, located underneath the Time Ruler, contains buttons that let you quickly add commonly used nodes to the Node Editor. Clicking any of these buttons adds that node after the currently selected node in the node tree, or adds an unconnected instance of that node if no nodes are selected. The Toolbar can be customized and saved for specific tasks.

The default toolbar is divided into sections that group commonly used nodes together. As you hover the pointer over any button, a tooltip shows you that node’s name.

- **Loader/Saver nodes (Fusion Studio Only):** The Loader node is the primary node used to select and load clips from the hard drive. The Saver node is used to write or render your composition to disk.

- **Generator/Title/Paint nodes:** The Background and FastNoise generators are commonly used to create all kinds of effects, and the Title generator is obviously a ubiquitous tool, as is Paint.

- **Color/Blur nodes:** ColorCorrector, ColorCurves, HueCurves, and BrightnessContrast are the four most commonly used color adjustment nodes, while the Blur node is ubiquitous.

- **Compositing/Transform nodes:** The Merge node is the primary node used to composite one image against another. ChannelBooleans and MatteControl are both essential for reassigning channels from one node to another. Resize alters the resolution of the image, permanently altering the available resolution, while Transform applies pan/tilt/rotate/zoom effects in a resolution-independent fashion that traces back to the original resolution available to the source image.

- **Mask nodes:** Rectangle, Ellipse, Polygon, and BSpline mask nodes let you create shapes to use for rotoscoping, creating garbage masks, or other uses.

- **Particle system nodes:** Three particle nodes let you create complete particle systems when you click them from left to right. pEmitter emits particles in 3D space, while pMerge lets you merge multiple emitters and particle effects to create more complex systems. pRender renders a 2D result that can be composited against other 2D images.

- **3D nodes:** Seven 3D nodes let you build sophisticated 3D scenes. These nodes auto attach to one another to create a quick 3D template when you click from left to right. ImagePlane3D lets you connect 2D stills and movies for compositing into 3D scenes. Shape3D lets you create geometric primitives of different kinds. Text3D lets you build 3D text objects. Merge3D lets you composite multiple 3D image planes, primitive shapes, and 3D text together to create complex scenes, while SpotLight lets you light the scenes in different ways, and Camera3D lets you frame the scene in whatever ways you like. Renderer3D renders the final scene and outputs 2D images and auxiliary channels that can be used to composite 3D output against other 2D layers.

When you're first learning to use Fusion, these nodes are really all you need to build most common composites. Once you've become a more advanced user, you'll still find that these are truly the most common operations you'll use.

**Customizing the Toolbar**

You can add and remove tools from the Fusion toolbar and then save the custom toolbar as a preset. New tools can be added by dragging them from the Effects Library or the Node Editor, and dividers can be added to group tool sets together.
To create a new toolbar, do the following:
1 Right click in an empty area of the toolbar and choose Customize > Create Toolbar from the contextual menu.
2 Enter a name for the toolbar in the dialog box, and click OK.

To rearrange the tools in the toolbar, do the following:
1 Create a new custom toolbar or select an existing custom toolbar.
2 Drag a node in the toolbar to a new location.

To add a tool to the toolbar:
1 Create a new custom toolbar or select an existing custom toolbar.
2 Do one of the following:
   – Drag a node from the Effects Library to the location on the toolbar where you want it added.
   – Drag a node from the Node Editor to the location on the toolbar where you want it added.

To add a divider to a toolbar, do the following:
1 Create a new custom toolbar or select an existing custom toolbar.
2 Right-click over any tool and choose Customize > Add Divider. A divider is added to the right of the tool.

To remove a tool from a toolbar, do the following:
1 Create a new custom toolbar or select an existing custom toolbar.
2 Right-click over any tool and choose Remove [name of tool].

To remove a group of tools between two dividers, do the following:
1 Create a new custom toolbar or select an existing custom toolbar.
2 Right-click over any tool in a group and choose Remove Group.

To prevent a custom toolbar from being modified:
   – Right-click over the toolbar and choose Lock from the contextual menu.

To switch between toolbars:
   – Right-click over the toolbar and choose the custom toolbar name or choose Default to return to Fusion’s default toolbar.

To delete a custom toolbar, do the following:
1 Right-click over the toolbar and choose the name of the custom toolbar you want to delete.
2 Right-click over the toolbar again and choose Customize > Remove [toolbar name].
Node Editor

The Node Editor is the heart of Fusion because it’s where you build the tree of nodes that makes up each composition. Each node you add to the node tree adds a specific operation that creates one effect, whether it’s blurring the image, adjusting color, painting strokes, drawing and adding a mask, extracting a key, creating text, or compositing two images into one.

You can think of each node as a layer in an effects stack, except that you have the freedom to route image data in any direction to branch and merge different segments of your composite in completely nonlinear ways. This makes it easy to build complex effects, but it also makes it easy to see what’s happening, since the node tree doubles as a flowchart that clearly shows you everything that’s happening, once you learn to read it.

Adding Nodes to Your Composition

Depending on your mood, there are a few ways you can add nodes from the Effects Library to your composition. For most of these methods, if there’s a single selected node in the Node Editor, new nodes are automatically added after it, but if there are no selected nodes or multiple selected nodes, then new nodes are added as disconnected from anything else.

Methods of adding nodes include:

- Click a button in the toolbar.
- Open the Effects Library, find the node you want in the relevant category, and click once on a node you’d like to add.
- Right-click on a node and choose Insert Tool from the drop-down menu to add it after the node you’ve right-clicked on. Or, you can right-click on the background of the Node Editor to use that submenu to add a disconnected node.
- Press Shift-Spacebar to open a Select Tool dialog, type characters corresponding to the name of the node you’re looking for, and press the Return key (or click OK) when it’s found. Once you learn this method, it’ll probably become one of your most frequently used ways of adding nodes.
Removing Nodes from Your Composition

Removing nodes is as simple as selecting one or more nodes, and then pressing the Delete or Backspace keys.

Identifying Node Inputs and Node Outputs

Each node displays small colored connections around the edges. One or more arrows represent inputs, and the square connection represents the tool’s processed output, of which there is always only one. If you hover the pointer over any of a node’s inputs or output, the name of that input or output immediately appears in the Status bar. If you wait for a few more moments, a floating tooltip displays the same name right over the node.

Node Editing Essentials

Each node has inputs and outputs that are “wired together” using connections. The inputs are represented by arrows that indicate the flow of image data from one node to the next, as each node applies its effect and feeds the result (via the square output) to the next node in the tree. In this way, you can quickly build complex results from a series of relatively simple operations.
You can connect a single node’s output to the inputs of multiple nodes (called “branching”).

![Diagram of node branching](image)

One node branching to two to split the image to two operations

You can then composite images together by connecting the output from multiple nodes to certain nodes such as the Merge node that combines multiple inputs into a single output.

![Diagram of nodes merging](image)

Two nodes being merged together into one to create a composite

By default, new nodes are added from left to right in the Node Editor, but they can also flow from top to bottom, right to left, bottom to top, or in all directions simultaneously. Connections automatically reorient themselves along all four sides of each node to maintain the cleanest possible presentation as you rearrange other connected nodes.

![Diagram of multiple nodes](image)

Nodes can be oriented in any direction; the input arrows let you follow the flow of image data.
Navigating the Node Editor

As your Node tree gets larger, parts inevitably go offscreen. When a portion of the node tree is offscreen, a resizable Navigator pane appears in the upper-right corner. The Navigator is a miniature representation of the entire node tree that you can drag within to pan to different parts of your composition quickly. You can resize the navigator using a handle in the lower-left corner, and you can choose to show or hide the Navigator by right-clicking the Node Editor to access the Options submenu of the contextual menu.

There are other standard methods of panning and zooming around the Node Editor.

**Methods of navigating the Node Editor:**
- Middle-click and drag to pan around the Node Editor.
- Hold down Shift and Command and drag the Node Editor to pan.
- Press the Middle and Left mouse buttons simultaneously and drag to resize the Node Editor.
- Hold down the Command key, and use your mouse’s scroll control to resize the Node Editor.
- Right-click the Node Editor and choose an option from the Scale submenu of the contextual menu.
- Press Command-1 to reset the Node Editor to its default size.
- Drag two fingers on a track pad to pan.
- Hold the Command key down and drag two fingers on a track pad to resize the Node Editor.

**Vertical Node Editor Layouts**

Alternative Node View Layout presets located in the Fusion page allow for positioning the Node Editor vertically, either alongside the Inspector, or along the left side of the screen. This can be very helpful when animating in the Spline Editor or Keyframes Editor.

When in the Fusion page, you can choose the layouts from Workspace > Layout Presets. Choosing a vertical layout allows the node tree to flow from top to bottom, leaving much more room along the lower half of the screen for the Spline Editor or Keyframes Editor.
When using the vertical layouts, enabling the Flow > Vertical Build Direction option in the Fusion settings will cause all new Node trees to build vertically, leaving maximum room for Fusion’s animation tools.

You can then save alternative layouts based on these two vertical presets using the Workspace > Layout Presets submenu.

When you want to return to the default horizontal Node Editor layout, just choose Workspace > Layout Presets > Fusion Presets > Default.

These Layout options are not available in Fusion Studio, however, you can use the Floating Frame to position the Node Editor wherever you like.

**Keeping Organized**

As you work, it’s important to keep the node trees that you create tidy to facilitate a clear understanding of what’s happening. Fortunately, the Fusion Node Editor provides a variety of methods and options to help you with this, found within the Options and Arrange Tools submenus of the Node Editor contextual menu.

**Status Bar**

The Status bar in the lower-left corner of the Fusion window shows you a variety of up-to-date information about things you’re selecting and what’s happening in Fusion. For example, hovering the pointer over a node displays information about that node in the Status bar. Additionally, the currently achieved frame rate appears whenever you initiate playback, and the percentage of the RAM cache that’s used appears at all times. Other information, updates, and warnings appear in this area as you work.
Occasionally the Status bar will display a badge to let you know there's a message in the console you might be interested in. The message could be a log, script message, or error.

A notification that there's a message in the Console

**Effects Library**

The Effects Library in Fusion shows all the nodes and effects available in Fusion, including third-party OFX plug-ins, if installed. If you are using DaVinci Resolve, Resolve FX also appear in the OFX category. While the toolbar shows many of the most common nodes you'll use in any composite, the Effects Library contains every single tool available in Fusion, organized by category, with each node ready to be quickly added to the Node Editor. Suffice it to say that there are many, many more nodes available in the Effects Library than on the toolbar, spanning a wide range of uses.

The hierarchical category browser of the Effects Library is divided into several sections depending on whether you are using Fusion Studio or the Fusion page within DaVinci Resolve. The Tools section is the most often used since it contains every node that represents an elemental image-processing
operation in Fusion. The OpenFX section contains third-party plug-ins, and if you are using the Fusion page, it also contains ResolveFX, which are included with DaVinci Resolve. A third section, only visible when using the Fusion page in DaVinci Resolve, is the Templates section. The Template section contains a variety of additional content including templates for Lens Flares, Backgrounds, Generators, Particle Systems, Shaders (for texturing 3D objects), and other resources for use in your composites.

![The Templates section of the Effects Library](image)

The Effects Library's list can be made full height or half height using a button at the far left of the UI toolbar.

## The Inspector

The Inspector is a panel on the right side of the Fusion window that you use to display and manipulate the parameters of one or more selected nodes. When a node is selected in the Node Editor, its parameters and settings appear in the Inspector.

![The Inspector shows parameters from one or more selected nodes.](image)
The Tools and Modifiers Panels

The Fusion Inspector is divided into two panels. The Tools panel is the main panel that shows you the parameters of selected nodes. The Modifiers panel shows optional extensions to the standard parameters of a tool. In the following image, a Perturb modifier has been added to a parameter to add random animation to that parameter, and the controls found on the Modifier panel let you customize what kind of randomness is being added.

Other nodes display node-specific items here. For example, Paint nodes show each brush stroke as an individual set of controls in the Modifiers panel, available for further editing or animating.

Parameter Header Controls

A cluster of controls appears at the top of every node’s controls in the Inspector.

– **Set Color:** A pop-up menu that lets you assign one of 16 colors to a node, overriding a node’s own color.

– **Versions:** Clicking Versions reveals another toolbar with six buttons. Each button can hold an individual set of adjustments for that node that you can use to store multiple versions of an effect.

– **Pin:** The Inspector is also capable of simultaneously displaying all parameters for multiple nodes you’ve selected in the Node Editor. Furthermore, a Pin button in the title bar of each node’s parameters lets you “pin” that node’s parameters into the Inspector so that they remain there even when that node is deselected, which is valuable for key nodes that you need to adjust even while inspecting other nodes of your composition.

– **Lock:** Locks that node so that no changes can be made to it.

– **Reset:** Resets all parameters within that node.

Parameter Tabs

Many nodes expose multiple tabs’ worth of controls in the Inspector, seen as icons at the top of the parameter section for each node. Click any tab to expose that set of controls.
**Keyframes Editor**

The Keyframes Editor displays each node in the current composition as a stack of layers within a miniature timeline. The order of the layers is largely irrelevant as the order and flow of connections in the node tree dictate the order of image-processing operations. You use the Keyframes Editor to trim, extend, or slide Loader, MediaIn, and effects nodes, or to adjust the timing of keyframes, which appear superimposed over each effect node unless you open them up into their editable track.

The Keyframes Editor is used to adjust the timing of clips, effects, and keyframes.

**Keyframes Editor Control Summary**

At the top, a series of zoom and framing controls let you adjust the work area containing the layers.

- A Horizontal zoom control lets you scale the size of the editor.
- A Zoom to Fit button fits the width of all layers to the current width of the Keyframes Editor.
- A Zoom to Rect tool lets you draw a rectangle to define an area of the Keyframes Editor to zoom into.
- A Sort pop-up menu lets you sort or filter the tracks in various ways.
- An Option menu provides access to many other ways of filtering tracks and controlling visible options.

A timeline ruler provides a time reference, as well as a place in which you can scrub the playhead.

At the left, a track header contains the name of each layer, as well as controls governing that layer.

- A lock button lets you prevent a particular layer from being changed.
- Nodes that have been keyframed have a disclosure control, which when opened displays a keyframe track for each animated parameter.

In the middle, the actual editing area displays all layers and keyframe tracks available in the current composition.

At the bottom-left, Time Stretch and Spreadsheet mode controls provide additional ways to manipulate keyframes.

At the bottom right, the Time/TOffset/TScale drop-down menu and value fields let you numerically alter the position of selected keyframes either absolutely, relatively, or based on their distance from the playhead.
Adjusting Clip Timings

Each Loader or MediaIn node that represents a clip used in a composition is represented as a layer in this miniature timeline. You can edit a layer’s In or Out points by positioning the pointer over the beginning or end of a segment and using the resize cursor to drag that point to a new location. You can slide a layer by dragging it to the left or right, to better line up with the timing of other elements in your composition.

The Keyframes Editor also lets you adjust the timing of elements that you’ve added from directly within Fusion.

Adjusting Effect Timings

Each effect node also appears as a layer, just like clips. You can resize the In and Out points of an effect layer, and slide the entire layer forward or backward in time, just like a Loader or MediaIn layers. If you trim an effect layer to be shorter than the duration of the composition, the effect cuts in at whichever frame the layer begins, and cuts out after the last frame of that layer, just like a clip on a timeline.

Adjusting Keyframe Timings

When you’ve animated an effect by adding keyframes to a parameter in the Inspector, the Keyframes Editor is used to edit the timing of keyframes easily. By default, all keyframes applied to parameters within a particular node’s layer appear superimposed in one flat track over the top of that layer.

To edit keyframes, you can click the disclosure control to the left of any animated layer’s name in the track header, which opens up keyframe tracks for every keyframed parameter within that layer.

Keyframe tracks exposed

Keyframe Editing Essentials

Here’s a short list of keyframe editing methods that will get you started.

Methods of adjusting keyframes:

– You can click on a single keyframe to select it.
– You can drag a bounding box over a series of keyframes to select them all.
– You can drag keyframes left and right to reposition them in time.
– You can right-click one or more selected keyframes and use commands from the drop-down menu to change keyframe interpolation, copy/paste keyframes, or even create new keyframes.
– You can Option-drag one or more selected keyframes to drag a duplicate of them to another position in the keyframe track.

To change the position of a keyframe using the toolbar, do one of the following:

– Select a keyframe, and then enter a new frame number in the Time Edit box.
– Choose T Offset from the Time Editor pop-up, select one or more keyframes, and enter a frame offset.
Choose T Scale from the Time Editor pop-up, select one or more keyframes, and enter a multiplier added to the current playhead frame position. For instance, if the playhead is on frame 10 and the keyframe is on frame 30, entering the TScale value of 2 will position the keyframe on frame 50. The distance between the playhead and original keyframe is 20, so \((20 \times 2) = 40\), which is then added to the playhead position.

**Time Stretching Keyframes**

If you select a range of keyframes in a keyframe track, you can turn on the Time Stretch tool to show a box used to squeeze and stretch the entire range of keyframes relative to one another. The Time Stretcher changes the overall timing of a sequence of keyframes without losing the relative timing from one keyframe to the next. Alternatively, you can turn on Time Stretch and draw a bounding box around the keyframes you want to adjust to create a time-stretching boundary that way. Click the Time Stretch tool again to turn it off.

![Time stretching keyframes](image1)

**The Keyframe Spreadsheet**

If you turn on the Spreadsheet and then click on the name of a layer in the keyframe track, the numeric time position and value (or values if it’s a multi-dimensional parameter) of each keyframe appear as entries in the cells of the Spreadsheet. Each column represents one keyframe, while each row represents a single aspect of each keyframe.

![Editing keyframes in the Spreadsheet](image2)

For example, if you’re animating a motion path, then the “Key Frame” row shows the frame each keyframe is positioned at, and the “Path1Displacement” row shows the position along the path at each keyframe. If you change the Key Frame value of any keyframe, you’ll move that keyframe to a new frame of the Timeline.

**Spline Editor**

The Spline Editor provides a more detailed environment for editing the timing, value, and interpolation of keyframes. Using control points at each keyframe connected by splines (also called curves), you can adjust how animated values change over time. The Spline Editor has four main areas: the Zoom and Framing controls at the top, the Parameter list at the left, the Graph Editor in the middle, and the toolbar at the bottom.
The Spline Editor is divided into the Zoom controls at top, Parameter list at left, Graph Editor, and toolbar.

**Spline Editor Control Summary**

At the top, a series of Zoom and Framing controls let you adjust the work area containing the curves.

- Vertical and horizontal zoom controls let you scale the size of the editor.
- A Zoom to Fit button fits the width of all curves to the current width of the Spline Editor.
- A Zoom to Rect tool lets you draw a rectangle to define an area of the Spline Editor to zoom into.
- A Sort drop-down menu lets you sort or filter the curves in various ways.
- An Option menu provides access to many other ways of filtering curves and controlling visible options.

A Timeline ruler provides a time reference, as well as a place in which you can scrub the playhead.

The Parameter list at the left is where you decide which splines are visible in the Graph view. By default, the Parameter list shows every parameter of every node in a hierarchical list. Checkboxes beside each name are used to show or hide the curves for different keyframed parameters. Color controls let you customize each spline's tint to make splines easier to see in a crowded situation.

The Graph view that takes up most of this panel shows the animation spline along two axes. The horizontal axis represents time, and the vertical axis represents the spline's value. Selected control points show their values in the edit fields at the bottom of the graph.

Lastly, the toolbar at the bottom of the Spline Editor provides controls to set control point interpolation, spline looping, or choose Spline editing tools for different purposes.

**Choosing Which Parameters to Show**

Before you start editing splines to customize or create animation, you need to choose which parameter's splines you want to work on.

**To show every parameter in every node:**

- Click the Splines Editor Option menu and choose Expose All Controls. Toggle this control off again to go back to viewing what you were looking at before.

**To show splines for the currently selected node:**

- Click the Splines Editor Option menu and choose Show Only Selected Tool.
**Essential Spline Editing**

The Spline Editor is a deep and sophisticated environment for keyframe and spline editing and retiming, but the following overview will get you started using this tool for creating and refining animation.

**To select one or more control points:**
- Click any control point to select it.
- Command-click multiple control points to select them.
- Drag a bounding box around multiple control points to select them as a group.

**To edit control points and splines:**
- Click anywhere on a spline to add a control point.
- Drag one or more selected control points to reshape the spline.
- Shift-drag a control point to constrain its motion vertically or horizontally.

**To edit Bézier curves:**
- Select any control point to make its Bézier handles visible, and drag the Bézier handles.
- Command-drag a Bézier handle to break the angle between the left and right handles.

**To delete control points:**
- Select one or more control points and press the Delete or Backspace key.

**Essential Spline Editing Tools and Modes**

The Spline Editor toolbar at the bottom contains a mix of control point interpolation buttons, Spline loop modes, and Spline editing tools.

**Control Point Interpolation**

The first six buttons let you adjust the interpolation of one or more selected control points.

- **Smooth:** Creates automatically adjusted Bézier curves to create smoothly interpolating animation.
- **Flat:** Creates linear interpolation between control points.
- **Invert:** Inverts the vertical position of non-animated LUT splines. This does not operate on animation splines.
- **Step In:** For each keyframe, creates sudden changes in value at the next keyframe to the right. Similar to a hold keyframe in After Effects® or a static keyframe in the DaVinci Resolve Color page.
- **Step Out:** Creates sudden changes in value at every keyframe for which there’s a change in value at the next keyframe to the right. Similar to a hold keyframe in After Effects or a static keyframe in the DaVinci Resolve Color page.
- **Reverse:** Reverses the horizontal position of selected keyframes in time, so the keyframes are backward.
Spline Loop Modes
The next three buttons let you set up spline looping after the last control point on a parameter’s spline, enabling a limited pattern of keyframes to animate over a far longer duration. Only the control points you’ve selected are looped.

- **Set Loop**: Repeats the same pattern of keyframes over and over.
- **Set Ping Pong**: Repeats a reversed set of the selected keyframes and then a duplicate set of the selected keyframes to create a more seamless pattern of animation.
- **Set Relative**: Repeats the same pattern of selected keyframes but with the values of each repeated pattern of keyframes being incremented or decremented by the trend of all keyframes in the selection. This results in a loop of keyframes where the value either steadily increases or decreases with each subsequent loop.

Spline Editing Tools
The next five buttons provide specialized Spline editing tools.

- **Select All**: Selects every keyframe currently available in the Spline Editor.
- **Click Append**: Click once to select this tool and click again to de-select it. This tool lets you add or adjust keyframes and spline segments (sections of splines between two keyframes) depending on the keyframe mode you’re in. With Smooth or Linear keyframes, clicking anywhere above or below a spline segment adds a new keyframe to the segment at the location where you clicked. With Step In or Step Out keyframes, clicking anywhere above or below a line segment moves that segment to where you’ve clicked.
- **Time Stretch**: If you select a range of keyframes, you can turn on the Time Stretch tool to show a box you can use to squeeze and stretch the entire range of keyframes relative to one another, to change the overall timing of a sequence of keyframes without losing the relative timing from one keyframe to the next. Alternatively, you can turn on Time Stretch and draw a bounding box around the keyframes you want to adjust to create a time-stretching boundary that way. Click Time Stretch a second time to turn it off.
- **Shape Box**: Turn on the Shape Box to draw a bounding box around a group of control points you want to adjust in order to horizontally squish and stretch (using the top/bottom/left/right handles), corner pin (using the corner handles), move (dragging on the box boundary), or corner stretch (Command-drag the corner handles).
- **Show Key Markers**: Turning on this control shows keyframes in the top ruler that correspond to the frame at which each visible control point appears. The colors of these keyframes correspond to the color of the control points they’re indicating.
Thumbnail Timeline in the Fusion Page

In the Fusion page of DaVinci Resolve, the Thumbnail timeline (hidden by default) can be opened by clicking the Clips button in the UI toolbar and appears underneath the Node Editor when it’s open. The Thumbnail timeline shows every clip in the current Timeline, giving you a way to navigate from one clip to another. Each thumbnail has a pop-up menu for creating and switching among multiple versions of compositions, and resetting the current composition, when necessary.

The Thumbnail timeline lets you navigate the Timeline and manage versions of compositions.

Right-clicking on any thumbnail exposes a contextual menu.

To open another clip:
- Click any thumbnail to jump to that clip’s composition. The current clip is outlined in orange.

To create and manage versions of compositions:
- **To create a new version of a composition:** Right-click the current thumbnail, and choose Create New Composition from the contextual menu.
- **To load a different composition:** Right-click the current thumbnail, and choose “NameOfVersion” > Load from the contextual menu.
- **To delete a composition:** Right-click the current thumbnail, and choose “NameOfVersion” > Delete from the contextual menu.

To reset the current composition:
- Right-click the current thumbnail, and choose Reset Current Composition from the contextual menu.

To change how thumbnails are identified:
- Double-click the area underneath any thumbnail to toggle among clip format, clip name, and a mystery that shall someday be solved by an intrepid team of adventurers embarking on a dangerous quest.
The Media Pool in the Fusion Page

In DaVinci Resolve’s Fusion page, the Media Pool continues to serve its purpose as the repository of all media you’ve imported into your project. This makes it easy to add additional clips to your compositions simply by dragging the clip you want from the Media Pool into the Node Editor. The media you add appears as a new MediaIn node in your composition, ready to be integrated into your node tree however you need it.

The Media Pool in Thumbnail mode showing video clips

**TIP:** If you drag one or more clips from the Media Pool onto a connection line between two nodes in the Node Editor, the clips are automatically connected to that line via enough Merge nodes to connect them all.

For more information on using the myriad features of the Media Pool, see Chapter 17, “Adding and Organizing Media with the Media Pool” in the DaVinci Resolve Reference Manual.

Importing Media Into the Media Pool on the Fusion Page

If you find yourself in the Fusion page and you need to quickly import a few clips for immediate use, you can do so in a couple of different ways.

**To add media by dragging one or more clips from the Finder to the Fusion page Media Pool (macOS only):**

1. Select one or more clips in the Finder.
2. Drag those clips into the Media Pool of DaVinci Resolve, or to a bin in the Bin list. Those clips are added to the Media Pool of your project.
To use the Import Media command in the Fusion page Media Pool:

1. With the Fusion page open, right-click anywhere in the Media Pool, and choose Import Media.
2. Use the Import dialog to select one or more clips to import, and click Open. Those clips are added to the Media Pool of your project.

For more information on importing media using the myriad features of the Media page, see Chapter 17, “Adding and Organizing Media with the Media Pool” in the DaVinci Resolve Reference Manual.

Bins in Fusion Studio

Bins in Fusion Studio are similar to the Media Pool in DaVinci Resolve. Bins are organizational panels that provide an easy way of accessing commonly used tools, settings, macros, compositions, and media content. They can keep all your custom content and resources close at hand, so you can use them without searching through your hard drives. Bins can also be shared over a network to improve a collaborative workflow with other Fusion Studio artists.

The Bins window

To open the Bins window:

– Choose File > Bins from the menu bar.

Similar to the Media Pool in DaVinci Resolve, when adding an item to the Fusion bins, a link is created between the item on disk and the bins. Fusion does not copy the file into its own cache or hard drive space. The file remains in its original format and in its original location.

Bins Interface

The Bins window is actually a separate application used to save content you may want to reuse at a later time. The Bins window is separated into two panels. The sidebar on the left is a bin list where items are placed into categories, while the panel on the right displays the selected bin’s content.
The Bin list organizes content into bins or folders using a hierarchical List view. These folders can be organized to suit your workflow, but standard folders are provided for Clips, Compositions, Favorites, Settings, and Tools. Parent folders contain subfolders that hold the content. For instance, the Tools bin is a parent folder to all the categories of tools. To access subfolders, click the disclosure arrow to the left of the parent folder's name.

When you select a bin from the bin list, the contents of the folder are displayed in the Contents panel as thumbnail icons.

A toolbar along the bottom of the bin provides access to organization, playback, and editing controls.

- **New Folder**: Creates a new folder in the current window.
- **New Reel**: Creates an empty reel that can contain multiple clips edited together into a timeline.
- **New Clip**: Opens a dialog to link a new media file into a bin.
- **Studio Player**: Opens a playback viewer for a selected clip.
– **Icon/List view:** This button toggles between showing contents of a bin in thumbnail view and list view.

– **Checkerboard:** Shows a checkerboard pattern in a clip thumbnail to signify transparency.

– **Thumbnail size:** Provides a few preset sizes for thumbnail icons.

Right-clicking in any area of the bin window displays a pop-up menu to access most of a bin’s features. Right-clicking on an item in a bin shows the same menu with additional options for renaming, playing, or deleting the item.

**The Bin Studio Player**

Selecting a clip in a bin and clicking the Studio Player button or double-clicking the clip opens the Studio Player. The Studio Player can be used to view clips, view metadata, and add notes.


**The Console**

The Console is a window in which you can see the error, log, script, and input messages that may explain something Fusion is trying to do in greater detail. The Console is also where you can read FusionScript outputs, or input FusionScripts directly. In DaVinci Resolve, the Console is available by choosing Workspace > Console or choosing View > Console in Fusion Studio. There is also a Console button in the Fusion Studio User Interface toolbar.

Occasionally the Status bar displays a badge to let you know there’s a message in the Console you might be interested in.
A toolbar at the top of the Console contains controls governing what the Console shows. At the top left, the Clear Screen button clears the contents of the Console. The next four buttons toggle the visibility of error messages, log messages, script messages, and input echoing. Showing only a particular kind of message can help you find what you’re looking for when you’re under the gun at 3:00 in the morning. The next three buttons let you choose the input script language. Lua 5.1 is the default and is installed with Fusion. Python 2.7 and Python 3.6 require that you install the appropriate Python environment on your computer. Because scripts in the Console are executed immediately, you can switch between input languages at any time.

At the bottom of the Console is an Entry field. You can type scripting commands here for execution in the current comp context. Scripts are entered one line at a time, and are executed immediately. For more information on scripting, see the Fusion Scripting Manual.

Customizing Fusion

This section explains how you can customize Fusion to accommodate whatever workflow you’re pursuing.

The Fusion Settings Window

Fusion has its own settings window, accessible by choosing Fusion > Fusion Settings in DaVinci Resolve, or in Fusion Studio by choosing Fusion > Preferences on macOS or File > Preferences on Windows or Linux. This window has a variety of options for customizing the Fusion experience. For more information, see Chapter 76, “Preferences” in the DaVinci Resolve Reference Manual or Chapter 13 in the Fusion Reference Manual.
Saving Fusion Layouts

It is possible to customize the layout and configuration of panels to suit the size of the desktop and monitor, or to match personal preferences.

**In DaVinci Resolve, configure and resize the panels you want displayed and then:**
– Choose Workspace > Layout Presets > Save Layout Presets.

**In Fusion Studio, configure and resize the panels you want displayed and then:**
– Click the Grab Document Layout button in the Preferences > Layout panel to save the layout for all new Compositions.
– Click the Grab Program Layout button to remember the size and position of any floating views, and enable the Create Floating Views checkbox to automatically create the floating windows when Fusion restarts.

Showing and Hiding Panels

The UI toolbar at the top of the screen lets you open panels you need and hide those you don’t. It’s the simplest way to create a layout for your particular needs at the moment.
Resizing Panels

You can change the overall size of each panel using preset configurations, or you can adjust them manually. The viewers and Work panel are inverse of each other. The more space used to display the Work panel, the less space available for the viewers. To resize a panel, manually drag anywhere along the raised border surrounding the edges of the panel.

Fusion Studio Floating Frame

Fusion Studio includes a Floating Frame window that can be used to house any panel.

To place a panel in the Floating Frame, do the following:

1. In Fusion Studio, choose Window > New Floating Frame.
2. Right-click in the Floating Frame and choose the panel from Add View submenu.

When using multiple monitors, you can choose to have floating panels spread across your displays for greater flexibility.

Fusion Studio Keyboard Remapping

When using Fusion Studio, functions and tools can be mapped to hot keys on your keyboard by choosing Views > Customize Hotkeys.
The Fusion Hotkey Manager dialog is divided into two sections. The left is where you select the functional area where you want to assign a keyboard shortcut. The right side displays the keyboard shortcut if one exists. You can use the New button at the bottom of the dialog to add a new keyboard shortcut.

For instance, if you want to add a shortcut for a specific node:

1. Open the Keyboard Hotkey Manager.
2. Select Views > Effect from the Target area of the Hotkey Manager.
3. Below the Key/Action area, click the New button to create a new keyboard shortcut for the Node.
4. In the Edit Hotkey window, click the Tools disclosure arrow, and then select Blur to display all the Blur-related nodes.
5. Select Glow in the Action panel.
6. At the top of the Edit Hotkey window, type G as the shortcut for the Glow node, and then click OK.
7. Glow and the G hotkey will now appear in the Key/Action area on the right.
8. Click OK to close the Hotkey Manager.
9. Click in the Node Editor and press G to add a Glow node.

**Undo and Redo**

Undo and Redo commands let you back out of steps you’ve taken or commands you’ve executed and reapply them if you change your mind. Fusion is capable of undoing the entire history of things you’ve done since creating or opening a particular project. When you close a project, its entire undo history is purged. The next time you begin work on a project, its undo history starts anew.

There is no practical limit to the number of steps that are undoable (although there may be a limit to what you can remember).

**To simply undo or redo changes you’ve made one at a time:**

– Choose Edit > Undo (Command-Z) to undo the previous change.

– Choose Edit > Redo (Shift-Command-Z) to redo to the next change.

**Undo History in DaVinci Resolve**

When using the Fusion page in DaVinci Resolve, you can also undo several steps at a time using the History submenu and window. At the time of this writing, this only works for multiple undo steps in the Media, Cut, Edit, and Fairlight pages.

**To undo and redo using the History submenu:**

1. Open the Edit > History submenu, which shows (up to) the last 20 things you’ve done.
2. Choose an item on the list to undo back to that point. The most recent thing you’ve done appears at the top of this list, and the change you’ve just made appears with a check next to it. Steps that have been undone but that can still be redone remain in this menu, so you can see what’s possible. However, if you’ve undone several changes at once and then you make a new change, you cannot undo any more and those steps disappear from the menu.
Once you’ve selected a step to undo to, the menu closes and the project updates to show you its current state.

**To undo and redo using the Undo window:**

1. Choose Edit > History > Open History Window.

2. When the History dialog appears, click an item on the list to undo back to that point. Unlike the menu, in this window the most recent thing you’ve done appears at the bottom of this list. Selecting a change here grays out changes that can still be redone, as the project updates to show you its current state.

3. When you’re done, close the History window.

**Sharing Memory with Other DaVinci Resolve Pages**

When using the Fusion page within DaVinci Resolve, the Memory and GPU panel in the Preferences window controls the overall amount of system memory used by the application and a subset allocated to the Fusion page. The Fusion page is limited to roughly 65% of the total memory allocated to DaVinci Resolve. The memory allocated to the Fusion page is released when you are not actively working on the page.
Chapter 64

Getting Clips into Fusion

This chapter details the various ways you can move clips into Fusion as you build your compositions.

Contents

Preparing Compositions in the Fusion Page 1043
Working on Single Clips in the Fusion Page 1043
Turning One or More Clips into Fusion Clips 1044
Adding Fusion Composition Generators 1045
Creating a Fusion Composition Clip in a Bin 1046
Using Fusion Transitions 1046
Adding Clips from the Media Pool 1047
Adding Clips from the File System 1048
Using MediaIn Nodes 1048
MediaIn Node Inputs 1048
Inspector Properties of MediaIn Nodes 1048
Using Loader and Saver Nodes in the Fusion Page 1051
Preparing Compositions in Fusion Studio 1053
Setting Up a Composition 1055
Reading Clips into Fusion Studio 1056
Aligning Clips in a Fusion Studio Composition 1057
Loader Node Inputs 1058
Using Proxies for Better Performance 1058
Presetting Proxy Quality 1059
File Format Options 1060
Loading Audio WAV Files in Fusion Studio 1062
Preparing Compositions in the Fusion Page

Ordinarily, clips come into the Fusion page from the Edit or Cut page Timeline as either a single clip, or as multiple layers contained within a Fusion clip. You can also add clips to a composition directly from DaVinci Resolve’s Media Pool. How clips find their way into a Fusion composition can determine how they function within that composition and what resolution that composition outputs to the rest of DaVinci Resolve.

Working on Single Clips in the Fusion Page

Positioning the playhead over a clip in the Edit page or Cut page Timeline and clicking the Fusion page button causes that clip to appear in the Fusion page as a single MediaIn node connected to a MediaOut node. Only the topmost visible clip is taken into Fusion. Clips that aren’t visible because they’re on lower tracks with clips above them are ignored, unless you disable the clips or tracks that appear above. These very simple default compositions are referred to unofficially in this manual as “single-clip compositions.”

The MediaIn node represents the image that’s fed to the Fusion page for further work, and the MediaOut node represents the final output that’s fed onward to the Color page for grading.

This initial node structure makes it easy to quickly use the Fusion page to create relatively simple effects using the procedural flexibility of node-based compositing.

For example, if you have a clip that’s an establishing shot, with no camera motion, that needs some fast paint to cover up a bit of garbage in the background, you can open the Fusion page, add a Paint node, and use the Clone mode of the Stroke tool to paint it out quickly.

Once you’ve finished, simply go back to the Edit or Cut page and continue editing, because the entire Fusion composition is encapsulated within that clip, similarly to how grades in the Color page are also encapsulated within a clip. However you slip, slide, ripple, roll, or resize that clip, the Fusion effects you’ve created and the Color page grades you’ve made follow that clip’s journey through your edited Timeline.
**TIP:** While you’ll likely want to do all the compositing for a greenscreen style effect in the Fusion page, it’s also possible to add a keyer, such as the excellent DeltaKeyer node, between the MediaIn and MediaOut nodes, all by itself. When you pull a key this way, the alpha channel is added to the MediaOut node, so your clip on the Edit page has transparency, letting you add a background clip on a lower track of your Edit page Timeline.

**How Nodes Are Named**

While the documentation refers to nodes by their regular name, such as “MediaIn,” the actual names of nodes in the Fusion Node Editor have a number appended to them, to indicate which node is which when you have multiple instances of a particular type of node.

**Turning One or More Clips into Fusion Clips**

For situations where you know you’re creating a more ambitious composited effect that requires multiple layers edited together with very specific timings, you can create a “Fusion clip” right from the Timeline. For example, if you have a foreground greenscreen clip, a background clip, and an additional graphic clip, you can stack them all on the Timeline as superimposed clips. You can then use the Edit page slip and slide features to align their timings so they work together as necessary. You can also edit multiple consecutive clips together that you want to use in a composition as a series of clips. Once that’s done, you can select every clip in the stack to create a Fusion clip, so you can easily use all these superimposed layers within a Fusion composite.

**To create a Fusion clip:**

1. Edit all the clips you want to use in the Edit page Timeline.
2. Select all clips you want to be in the same composite at once.
3. Right-click one of the selected clips and choose New Fusion Clip from the contextual menu.
4. A new clip, named “Fusion Clip X” (where X is an automatically incrementing number) appears in the currently selected bin of the Media Pool and in the Timeline to replace the previously selected clips.
5. With the playhead parked over that clip, open the Fusion page to see the new arrangement of those clips in the Fusion page Node Editor.
The nice thing about creating a Fusion clip is that every superimposed clip in a stack is automatically connected into a cascading series of Merge nodes that create the desired arrangement of clips. Note that whatever clips were in the bottom of the stack in the Edit page appear at the top of the Node Editor in the Fusion page, but the arrangement of background and foreground input connections is appropriate to recreate the same compositional order.

**TIP:** Fusion clips change the working resolution of the individual clips to match the Timeline resolution. For instance, if two 4K clips are stacked one on top of the other in an HD Timeline, creating a Fusion clip resizes the clips to HD. The full resolution of the individual 4K clips is not available in Fusion. To maintain the full resolution of course clips, bring only one clip into the Fusion composition from the Edit or Cut page Timeline, and then bring other clips into the Fusion composition using the Media Pool.

### Adding Fusion Composition Generators

The Generator category of the Edit page Effects Library has a Fusion Composition generator. It’s useful for creating an empty placeholder in the Timeline that you later want to work on in the Fusion page to create a more fully-featured Fusion composition.

**To create a blank Fusion clip in the Edit page:**

1. Open the Effects Library, and select the Effects category.
2 Edit a Fusion Composition clip into the Timeline in whichever way is most convenient.
   a. You can drag a Fusion Composition clip into the Timeline, which will result in a clip that’s the length of the “Standard generator duration” preference, which is 5 seconds by default.
   b. You can set In and Out points in the Timeline, and drag the Fusion Composition clip onto any of the editing overlays of the Timeline viewer to perform that sort of edit to insert, overwrite, “place on top,” or ripple overwrite it into a specific place in the Timeline, for a specific duration.

3 A new clip named “Fusion Composition” appears in the Timeline. It initially displays only black in the Timeline viewer, since it’s a blank composition with no contents.

4 With the playhead parked over that clip, open the Fusion page. Since this composition is blank, there’s only a single MediaOut node in the Node Editor. At this point, you can add whatever media, generators, and other effects you require.

NOTE: Audio on a track beneath a Fusion Composition effect cannot be heard in the Fusion page.

Creating a Fusion Composition Clip in a Bin

You can create an empty Fusion Composition clip in any bin in the Media Pool without creating a Timeline. This method can be useful for creating motion graphics or titles when there is no Timeline or when you plan on using the clip in multiple Timelines.

To create a blank Fusion Composition clip in a bin:

1 Select the bin in the Media Pool where you want to save the Fusion Composition.
2 Right click in an empty area of the bin and choose New Fusion Composition.
3 In the New Fusion Composition clip dialog, enter a Name for the clip, a duration, and a frame rate, and then click Create.
4 The clip will appear in the bin. To open it in Fusion, do one of the following:
   – Double-click the Fusion Composition
   – Right-click over the Fusion Composition clip and choose Open in Fusion Page

Using Fusion Transitions

Specific Fusion transitions are available in the Edit page Effects Library. You can use these transitions to bring two clips and the transition between them into the Fusion Page. These transitions can then be modified and saved back to the Edit page Timelines or saved as a new, reusable Fusion Transition that appears in the Edit Page Effects library.

To apply and open a Fusion Transition:

1 Open the Effects Library, and select the Video Transitions category.
2 Scroll to the bottom of the transition list and drag one of the Fusion Transitions onto a cut in the Timeline.
3 Right-click over the Fusion Transition in the Timeline and choose Open in Fusion Page.
4 The Fusion page opens with two MediaIn nodes representing the two sides of the transitions. The MediaIn nodes connect to a cross dissolve or a group of nodes used to create the transition. At this point, you can modify the transition using masks or other nodes and return to the Edit page to see the results.
A Noise Dissolve Transition opened in the Fusion page.


Adding Clips from the Media Pool

You can open the Media Pool on the Fusion page and drag clips directly to the Node Editor to add them to your node tree.

![Dragging a clip from the Media Pool](Left), and dropping it onto your composition (Right).

When you add a clip by dragging it into an empty area of the Node Editor, it becomes another MediaIn node, disconnected, that’s ready for you to merge into your current composite in any one of a variety of ways.

**TIP:** Dragging a clip from the Media Pool on top of a connection line between two other nodes in the Node Editor adds that clip as the foreground clip to a Merge node.

When you add additional clips from the Media Pool, those clips becomes a part of the composition, similar to how Ext Matte nodes you add to the Color page Node Editor become part of that clip’s grade.

Audio with Media Pool Clips

Audio from a clip brought in through the Media Pool is muted by default. Hearing the audio from a Media Pool clip is a two step process.

**To hear audio from a clip brought in through the Media Pool, do the following:**

1. Select the clip in the Node Editor.
2. In the Inspector, click the Audio tab and select the clip name from the Audio Track drop-down menu.
3. Right-click the speaker icon in the toolbar, then choose the MediaIn for the Media Pool clip to solo its audio.
You can now use the speaker icon contextual menu to switch back and forth between all the MediaIn nodes.

**Adding Clips from the File System**

You also have the option of dragging clips from the file system directly into the Node Editor. When you do this, they'll be added to the currently selected bin of the Media Pool automatically. So, if you have a library of stock animated background textures and you've just found the one you want to use using your file system's search tools, you can simply drag it straight into the Node Editor to use it right away.

**Using MediaIn Nodes**

The MediaIn nodes in the Fusion Page are the foundation of every composition you create. This section provides more detail about the controls available for adjusting MediaIn and Loader nodes.

**MediaIn Node Inputs**

MediaIn nodes have one Effects mask input and one output. In the case of the Effects mask input, connecting a mask node such as a Polygon or B-Spline node creates an alpha channel in the MediaIn node.

**TIP:** If you connect a mask node without any shapes drawn, that mask outputs full transparency, with the result that the image output by the MediaIn node is uselessly blank. If you want to rotoscope over a MediaIn node, first create a disconnected mask node, and with the mask node selected (exposing its controls in the Inspector) and the MediaIn node loaded into the viewer, draw your mask. Once the shape you're drawing has been closed, you can connect the mask node to the MediaIn node's input, and you're good to go.

**Inspector Properties of MediaIn Nodes**

Which Inspector options are available for MediaIn nodes of your composition depends on how you imported the media.

**MediaIn Node Parameters for Clips in a Timeline**

When you create a composition using clips from the Edit page Timeline, the MediaIn nodes for those clips display fewer parameters than those imported directly from the Media Pool, because the timing of clips that have already been edited into a Timeline is already set.

The Inspector Image tab parameters for a clip from the Timeline
Image Tab

- **Clip Name:** Displays the name of that clip.
- **Process Mode:** Lets you choose whether the clip represented by that node will be processed as Full Frames, or via one of the specified interlaced methods.
- **MediaID:** A unique ID assigned by DaVinci Resolve for that clip.
- **Layer:** In the case of Photoshop PSD files, this selects the layer of the PSD file to use.

Source Color Space

The Color Space Type menu sets the color space of the media to help achieve a linear workflow. Unlike the Gamut tool, this doesn’t perform any actual color space conversion but rather adds the source space data into the metadata, if that metadata doesn’t already exist. The metadata can then be used downstream by a Gamut tool with the From Image option, or in a Saver if explicit output spaces are defined there.

- **Auto:** Passes along any metadata that might be in the incoming image.
- **Space:** Allows the user to set the color space from a variety of options.

Source Gamma Space

The Curve Type menu automatically determines or allows you to choose the Gamma setting for the image and allows the option to remove the Gamma curve to help achieve a linear workflow.

- **Auto:** Passes along any metadata that might be in the incoming image.
- **Space:** Allows you to choose a specific setting from a Gamma Space drop-down menu, while a visual graph lets you see a representation of the gamma setting you’ve selected.
- **Log:** Similar to the Log-Lin node, this option reveals specific log-encoded gamma profiles so that you can select the one that matches your content. A visual graph shows a representation of the log setting you’ve selected. When Cineon is selected from the Log Type menu, additional Lock RGB, Level, Soft Clip, Film Stock Gamma, Conversion Gamma, and Conversion table options are presented to finesse the gamma output.
- **Remove Curve:** Depending on the selected gamma space or on the gamma space found in Auto mode, the associated gamma curve is removed from the material, effectively converting it to output in a linear color space.
- **Pre-Divide/Post-Multiply:** Lets you convert “straight” alpha channels into pre-multiplied alpha channels, when necessary.

**TIP:** All content in the DaVinci Resolve Fusion page is processed using 32-bit floating-point bit depth, regardless of the content’s actual bit depth.

Audio Tab

The Inspector for the MediaIn node contains an Audio tab, where you can choose to solo the audio from the clip or hear all the audio tracks in the Timeline.
The MediaIn Audio tab

The Audio tab in the MediaIn node is used to select the track for playback, slip the audio timing, and reset the audio cache.

If the audio is out of sync when playing back in Fusion, the Audio tab's Sound Offset wheel allows you to slip the audio in subframe frame increments. The slipped audio is only modified in the Fusion page. All other pages retain the original audio placement.

**Purging the Audio Cache**

The audio and its settings are cached for faster performance. If you change which audio tracks you want to play back in Fusion, or you use the Sound Offset wheel to slip the audio tracks, you need to purge the audio cache. Also, if you return to the Edit, Cut, or Fairlight page and modify the audio levels, you need to purge the audio cache.

**To purge the audio cache after any change to the audio playback:**

- Click the Purge Audio Cache button in the Inspector.

The audio will be updated when you next play back the composition.

**Aligning Clips from the Media Pool**

When you add a clip from the Media Pool or your file system directly into a composition, the resulting MediaIn node has more options than clips from the Edit page Timeline. These additional options make it easier to align the Media Pool clips with other clips from the Edit or Cut page Timeline. You can also trim clips, hold the first or last frame for a longer duration than the original media, and reverse or loop the clip to get more range for your composition.
Below is a list of controls that are added beyond the controls that appear when a clip is added from the Edit or Cut page Timeline.

- **Global In/Out**: Use this control to specify the position of this node within the composition. For instance, when the clip is added to the comp from the Media Pool, it is added at frame 0. However, the MediaIn node from the Edit page Timeline may not start until a much later frame, based on where it is edited into the Timeline. Use Global In to specify the frame on which the clip starts so that it aligned with media from the Edit page Timeline. It is easiest to view and change the alignment of different clips in the comp while viewing the Keyframes Editor.

To slide the clip in time or align it to other clips without changing its length, place the mouse pointer in the middle of the range control and drag it to the new location, or enter the value manually in the Global In value control.

If the Global In and Out values are decreased to the point where the range between the In and Out values is smaller than the n number of available frames in the clip, Fusion automatically trims the clip by adjusting the Clip Time range control. If the Global In/Out values are increased to the point where the range between the In and Out values is larger than the number of available frames in the clip, Fusion automatically lengthens the clip by adjusting the Hold First/Last Frame controls. Extended frames are visually represented in the range control by changing the color of the held frames to purple in the control.

- **Trim**: The Trim range control is used to trim frames from the start or end of a clip. Adjust the Trim In to remove frames from the start and set Trim Out to specify the last frame of the clip. The values used here are offsets. A value of 5 in Trim In would use the 5th frame in the sequence as the start, ignoring the first four frames. A Trim Out value of 95 would stop loading frames after the 95th.

- **Hold First Frame/Hold Last Frame**: The Hold First Frame and Hold Last Frame controls will hold the first or last frame of the clip for the specified amount of frames. Held frames are included in a loop if the footage is looped.

- **Reverse**: Select this checkbox to reverse the footage so that the last frame is played first and the first frame is played last.

- **Loop**: Select this checkbox to loop the footage until the end of the project. Any lengthening of the clip using Hold First/Last Frame or shortening using Trim In/Out is included in the looped clip.

### Using Loader and Saver Nodes in the Fusion Page

The Loader and Saver nodes in Fusion Page are specifically used for workflows that center around multi-channel EXR files. OpenEXR media can contain high-quality floating-point image data, multiple matte channels, as well as auxiliary channels rendered from 3D software. The Loader node lets you add OpenEXR files to a composition directly from the file system, retaining all the channels that are embedded within that file. Saver nodes enable you to render either all or part of a composition as EXR files directly to disk, bypassing the DaVinci Resolve Deliver page.

**To import a multi-channel EXR image sequence into the Fusion page:**

1. Open the Fusion page.
2. Open the Effects Library, and select the Tools > I/O category, and click the Loader node.
3. In the OS navigation window that opens, select the EXR image sequence you want to import, and click Open.
4. A Loader node linked to the EXR file will appear in the Fusion page, although a clip will not appear in the Media Pool.
Loader Node Parameters

The image tab of Loader nodes shares parameters with MediaIn nodes, as described previously in this chapter. However, when using a Loader node for EXR files, the Format tab selectively enables and disables the use of specific auxiliary channels contained in the file.

Outputting Images Using Saver Nodes

Saver nodes render OpenEXR image sequences to disk directly from the Fusion page. Saver nodes can be added to any branch of a node tree, allowing you to export one or more subsets of nodes in a composition. You can add as many Saver nodes as you like to whichever branches of your composition’s node tree you need to output, to export multiple parts of a composition. For example, if a particular composition is made up of one branch of nodes working together to create a complex background, and another branch of nodes creating a foreground character with transparency, you could export the background and foreground branches as separate OpenEXR files using two Saver nodes.

To do this, simply create a Saver node after any set of nodes you want to output, and then open the Inspector and click Browse to choose a name and location for the rendered result.

When naming the file, you must add the .exr file extension. Fusion sets the output format accordingly. A four-digit frame number is automatically added before the filename extension. However, you can specify the frame padding by adding several zeroes to indicate the number of digits. For example, 000 signifies 001.

Once the Saver node is set up, output one or more Saver nodes, and choose Fusion > Render All Savers.
Manual Disk Caching Using Loader and Saver Nodes

The Loader and Saver nodes in the Fusion page are also useful for optimizing extremely complex and processor-intensive compositions. For example, you can render out specific branches of a node tree that no longer require frequent adjustment to OpenEXR via a Saver node, then reimport the result to take the place of the original branch of nodes in order to improve the performance of your composition. Used this way, Loader and Saver nodes provide a bulletproof manual workflow for caching using media files that will never be automatically purged unless you specifically delete them. As long as you retain the original branch of nodes, you can always readjust and re-render these manually cached parts of a composition, if necessary.

Preparing Compositions in Fusion Studio

The next few sections in this chapter cover preparing a project and adding clips into a composition when using Fusion Studio. The term composition, or comp, is used to refer to the Fusion project file. By default, opening the Fusion Studio application creates a new empty composition when it’s launched. A composition can contain single frames, image sequences, or movie files at various resolutions and bit depths. Knowing which files you can load in, how to set up a composition to handle them, and finally, reading those files in are the first steps in beginning to composite.

Opening, Closing, and Saving Compositions

As soon as you open Fusion Studio, a new empty composition is created. If necessary, you can also create or open multiple compositions at once. Each additional composition is opened as a tab to the main Fusion Studio window.

To create a second new composition:
- Choose File > New.

To open an existing composition, do one of the following:
- Choose File > Open.
- Choose File > Open Recent, and choose from the list of recently opened comps.
- Drag a composition file from an OS file browser into the tabbed composition area at the top of the Fusion Studio window.
- Double-click on a composition file in the OS file browser.
The following methods can be used to close the current composition:

– Choose File > Close from the menu at the top of the Fusion window.
– Click the Close X icon on the right of the composition’s tab.

If the composition has unsaved changes, a dialog box appears allowing you to save before closing.

**TIP:** Compositions that have unsaved changes will display an asterisk (*) next to the composition’s name in the Fusion Studio title bar and in the composition’s tab.

To save the current composition, you can do the following:

– Choose File > Save and enter a name if the comp has yet to be named.
– Choose File > Save As to save under a new name.
– Choose File > Save Version to save the current composition with an added three-digit version number at the end of the name. Each time you save a version, the number automatically increments and the comp file is saved in the same location as the first version.

**Auto Save**
Auto save automatically saves the composition to a temporary file at preset intervals. Auto saves help to protect you from loss of work due to power loss, software issues, or accidental closure.

To enable auto save for new compositions, choose Fusion Studio > Preferences, and then locate Global > General > Auto Save in the Preferences dialog.

An auto-save file does not overwrite the current composition in the file system. A file with the same name is created in the same folder as the composition but with the extension .autosave instead of .comp. Unsaved compositions will place the autosave file in the default folder specified by the Comp: path in the Paths panel of the Global Preferences.

If an auto-save file is present when Fusion Studio loads a composition, a dialog will appear asking to load the auto-saved or original version of the composition.

**The Composition File Format**
Composition files are saved as readable plain text files. Using plain text files to describe a composition makes it easier to integrate Fusion into structured, visual effects pipeline and asset management solutions.

Composition files can be opened and edited using any standard text editing program. However, it is never a good idea to open the file using a word processor, such as Microsoft Word or Apple Pages, as these will generally save additional formatting information which will make the composition unreadable to Fusion.

**Importing and Exporting a Composition from DaVinci Resolve**
Although the compositions created in DaVinci Resolve’s Fusion page are saved in the DaVinci Resolve database as .drp project files, you can import and export Fusion composition files when in the Fusion page. This makes it very easy to share Fusion compositions between the different applications.

**To export a Fusion composition from DaVinci Resolve:**
1. From within DaVinci Resolve, switch to the Fusion page with the composition you want to export.
2. Choose File > Export Fusion Composition.
3. A Save dialog appears in which you can enter a name and location from the exported Fusion composition.
A .comp extension is added to the end of the filename. Only the node tree created in the Fusion page is exported. Clips not added to the Node Editor will not appear in the Fusion Studio bins. ResolveFX added to the comp will also not translate from the Fusion page to Fusion Studio.

MediaIn nodes from DaVinci Resolve are automatically converted to Loader nodes, and if the file path remains identical, the media is automatically relinked.

MediaOut nodes are converted to Saver nodes.

The return trip can also be performed, saving a composition file from Fusion Studio and importing it into the Fusion page within DaVinci Resolve.

**To import a composition from Fusion Studio into the Fusion page within DaVinci Resolve:**

1. From within Fusion Studio, open the composition you want to move into the Fusion page.
2. From within DaVinci Resolve, switch to the Fusion page with an empty composition. The composition you import will completely replace the existing composition in the Fusion page Node Editor.
3. Choose File > Import Fusion Composition.
4. In the Open dialog, navigate to the Fusion comp and click Open.

The new comp is loaded into the Node Editor, replacing the previously existing composition.

**TIP:** To keep an existing comp in the Fusion page and merge a new comp from Fusion Studio, open Fusion Studio, select all the nodes in the Node Editor, and press Command-C to copy the selected nodes. Then, open DaVinci Resolve and switch the Fusion page with the composition you want, click in an empty location in the Node Editor, and press Command-V to paste the Fusion Studio nodes. Proceed to connect the pasted node tree into the existing one using a Merge or Merge 3D node.

**Setting Up a Composition**

Source media can come in a variety of formats, including HD, UHD, and 4K or larger. Often you will have different formats within a single comp. Each format has different properties, from resolution to color depth and gamma curve. Fusion can mix and match material of different formats together in a single composite, but it is important to note how Fusion Studio configures and combines materials of different formats when loading and merging them together.

When you open Fusion Studio, an empty composition is created. The first thing you do when starting on a new composition is to set the preferences to match the intended final output format. The preferences are organized into separate groups: one for global preferences, and one for the preferences of the currently opened composition.

Although the final output resolution is determined in the Node Editor, the Frame Format preferences are used to determine the default resolution used for new Creator tools (i.e., text, background, fractals, etc.), aspect ratio, as well as the frame rate used for playback.
Frame Format preferences for images generated in Fusion.

If the same frame format is used day after day, the global Frame Format preferences should match the most commonly used footage. For example, on a project where the majority of the source content will be 1080p high definition, it makes sense to set up the global preferences to match the frame format of the HD source content you typically use.

To set up the default Frame Format for new compositions, do the following:

1. Choose Fusion Studio > Preferences.
2. Click the Global and Default Settings disclosure triangle in the sidebar to open the Globals group.
3. Select the Frame Format category to display its options.

When you set options in the Global Frame Format category, they determine the default frame format for any new composition you create. They do not affect existing compositions or the composition currently open. If you want to make changes to existing compositions, you must open the comp. You can then select the Frame Format controls listed under the comp’s name in the sidebar.

For more information on preferences, see Chapter 76, “Preferences” in the DaVinci Resolve Reference Manual or Chapter 15 in the Fusion Reference Manual.

Reading Clips into Fusion Studio

Once the Frame Format preferences are set, you usually begin to create a composite by reading in source media. When Fusion reads in media, it doesn’t convert or move the original files; it simply reads the files in place, from whichever storage volume they’re on. You are always dealing with the original source files in their original location.

Source media is read into a comp using a Loader tool. Although there are other tools within Fusion Studio that you can use to generate images like gradients, fractals, or text, each still image, image sequence, or movie file must be added to your comp using a Loader tool.
To add media to your comp, do one of the following:

– Click Effects to open the Effects Library, and then select Tools > I/O > Loader.
– Click the Loader icon in the toolbar.
– Right-click over the Node Editor, and then choose Add Tool > I/O > Loader.
– Drag a file from an OS file browser window into the Node Editor.

If multiple files are dragged into the Node Editor, a separate Loader is added for each file. However, if you drag a single frame from an image sequence, the entire series of the image sequence is read into the comp using one Loader, as long as the numbers are sequential.

To add only one frame of an image sequence to your comp:

– Hold Shift while you drag a single frame from an image sequence into the Node Editor.

This comes in handy when you want to read in photographs from a digital camera that are numbered sequentially.

A Loader represents any clip, image file, or graphic that you bring into Fusion. However, other types of media can also be brought into Fusion Studio. Photoshop PSD files, SVG splines, and 3D models in the Alembic, FBX, and OBJ format can be imported using the File > Import menu.

**TIP:** Using File > Import > Footage creates a new composition along with a Loader node for the footage. The selected media is automatically used for the name of the composition.


**Aligning Clips in a Fusion Studio Composition**

When you add a clip into a composition, the resulting Loader node is added at frame 0 of the composition. However, the vital portion of the clip you are interested in may not start until a few frames or even seconds later. To ensure you can align the timing of each piece of media, each Loader includes timing and trimming options in the Inspector. You can also hold the first or last frame for a longer duration than the original media, and reverse or loop the clip to get more range for your composition.

At the top of the Inspector are the Global In and Global Out settings. This range slider determines when in your composition the clip begins and ends. It is the equivalent of sliding a clip along a track in a Timeline. The Hold First Frame and Hold Last Frame dials at the bottom of the Inspector allow you to freeze frames in case the clip is shorter than the composition’s global time.

Below the filename in the Inspector is a Trim In and Out range slider. This range slider determines the start frame and end frame of the clip. Dragging the Trim In will remove frames from the start of the clip, and dragging the Trim Out will remove frames from the end of the clip.
Use the Trim In/Out to remove unnecessary frames from the start or end of a clip.

Although you may remove frames from the start of a clip, the Global In always determines where in time the clip begins in your comp. For instance, if the Loader has a Global In starting on frame 0, and you trim the clip to start on frame 10, then frame 10 of the source clip will appear at the comp’s starting point on frame 0.

Instead of using the Inspector to adjust timing, it is visually more obvious if you use the Keyframes Editor. For more information on the Keyframes Editor and adjusting a clip’s time, see Chapter 70, “Animating in Fusion’s Keyframe Editor” in the DaVinci Resolve Reference Manual or Chapter 9 in the Fusion Reference Manual.

Loader Node Inputs

Loader nodes have one Effects mask input and one output. In the case of the Effects mask input, connecting a mask node such as a Polygon or B-Spline node automatically creates an alpha channel in the Loader node.

**TIP:** If you connect a Mask node without any shapes drawn, that mask outputs full transparency, so the result is that the image output by the MediaIn node is blank. If you want to rotoscope over a MediaIn node, first create a disconnected Mask node, and with the Mask node selected and the Media In node loaded into the viewer, draw your mask. Once the shape you’re drawing has been closed, connect the Mask node to the MediaIn node’s input, and you’re good to go.

Using Proxies for Better Performance

For increased performance, you can do one of two things:

- Generate smaller media files and write them to disk using Optimized Media in DaVinci Resolve
- Render out proxy files using Saver nodes in Fusion Studio

Both applications also allow you to generate proxies on-the-fly without rendering new files to disk using the Proxy and Auto Proxy options in the transport controls area.

To enable the Proxy and Auto Proxy options, you can do one of two things, depending on the version of Fusion you are using:

- In the Fusion page, right-click the empty area behind the transport controls to enable the Proxy option.
- In Fusion Studio, click the Proxy (Prx) button in the transport area to enable the usage of proxies.

The Proxy option reduces the resolution of the images as you view and work with them. Instead of displaying every pixel, the Proxy option processes one out of every x pixels interactively. In Fusion Studio, the value of x is determined by right-clicking the Prx button and selecting a proxy ratio from the drop-down menu. For instance, choosing 5 from the menu sets the ratio at 5:1. In the Fusion page, the proxy ratio is set by choosing Fusion > Fusion Settings and setting the Proxy slider in the General panel.

The Auto Proxy button enables Fusion to interactively degrade the image only while adjustments are made. The image returns to normal resolution when the control is released. Similar to the Prx button in Fusion Studio, you can set the Auto Proxy ratio by right-clicking the APrx button and choosing a ratio from the menu.

When a Loader node is selected, the Inspector includes a Proxy Filename field where you can specify a clip that will be loaded when the Proxy mode is enabled. This allows smaller versions of the image to be loaded to speed up file I/O from disk and processing. This is particularly useful when working with high resolution files like EXR that might be stored on a remote server. Lower resolution versions of the elements can be stored locally, reducing network bandwidth, interactive render times, and memory usage.

The proxy clip that you create must have the same number of frames as the original clip, and if using image sequences, the sequence numbers for the clip must start and end on the same frame numbers. If the proxies are the same format as the original files, the proxies will use the same format options in the Inspector as the originals.

**Presetting Proxy Quality**

When using Fusion Studio, rather than right-clicking over the Proxy button to set the proxy quality, you can preset the standard and Auto Proxy quality in the Fusion Preferences window. The General pane in the Preferences window includes sliders for both standard Proxy files and Auto Proxy files. These sliders designate the default ratio used to create proxies when the Proxy and Auto Proxy modes are turned on. These settings do not affect the final render quality.
**File Format Options**

The Fusion interface in DaVinci Resolve and Fusion Studio display specific options for various file formats in slightly different ways. Where Fusion Studio displays most file-specific options in the Loader’s Format tab, the Fusion page in most cases displays these options in the main Image tab of the MediaIn node. The only exception being the OpenEXR format. Its extensive options are displayed in a separate tab even in the MediaIn node of the Fusion page. Not all file formats have options. Only the DPX, OpenEXR, PSD, and QuickTime formats provide additional options when loaded.

**DPX**

The Format tab in Fusion Studio’s Loader node for DPX files is used to convert image data from logarithmic to linear. These settings are often left in bypass mode, and the Log to Linear conversion is handled using a Cineon Log node.

**OpenEXR**

The OpenEXR format provides a compact and flexible high dynamic range (float) format. The format supports a variety of extra non-RGBA channels and metadata. These channels can be viewed and enabled in the Format tab of the Inspector.

The Format tab in a Loader node Inspector displays Aux channels in EXR files.
Photoshop PSD
There are two methods for importing Photoshop PSD files. You can either import the PSD file and have it represented as a single node in the Node Editor or import the PSD and have each layer represented as a node in the Node Editor. If you do not need independent control over each layer or blend modes are not used when creating the PSD file, then importing the PSD file as a single node will make for a more manageable experience. If you do need control over each layer or Blend modes used in the PSD file are critical, then you should import the file so each layer becomes a node in the Node Editor. Each method is explained below for the Fusion page and Fusion Studio.

– Using the Media Pool in DaVinci Resolve's Fusion page: Any PSD file added to the Media Pool in DaVinci Resolve can be accessed from the Fusion page. After dragging the PSD file from the Media Pool into the Node Editor, the image appears as a MediaIn node. From there, you can select which layer to use from the PSD file from the Layer drop-down menu in the Inspector.

– Using a Loader node in Fusion Studio: This lets you read in Photoshop PSD files with the ability to select the layer in the PSD file that is used in the comp. Fusion can load any one of the individual layers stored in the PSD file, or the completed image with all layers. Transformation and adjustment layers are not supported.

To load all layers individually from a PSD file, with appropriate blend modes, do one of the following:

– In DaVinci Resolve, switch to the Fusion page and choose Fusion > Import > PSD.
– In Fusion Studio, choose File > Import > PSD.

Using either of the methods above creates a node tree where each PSD layer is represented by a node and one or more Merge nodes are used to combine the layers. The Merge nodes are set to the Apply mode used in the PSD file and automatically named based on the Apply mode setting.

QuickTime
QuickTime files can potentially contain multiple tracks. You can use the Format tab in the Inspector to select one of the tracks.
Loading Audio WAV Files in Fusion Studio

You can load WAV format audio-only files into Fusion Studio. The entire WAV file is loaded into RAM in order to quickly display the waveform in the Keyframe Editor. That being the case, it is best to use the shortest possible audio file you need for the Comp, so as not to use up more memory than necessary.

**TIP:** AIFF files can be loaded on macOS.

You can either load the audio file independent of any nodes, or load an audio file into the Saver node. The benefit of using a Saver node to load the audio is that you can view the audio waveforms in the Keyframes Editor.

To load a WAV audio file, do the following:

1. Right-click over the speaker icon and select Choose from the contextual menu.
2. In the file browser window, select the audio WAV file track to be used.

To load a WAV audio file using a Saver node, do the following:

1. Add a Saver node to the Node Editor.
2. In the Inspector, click the Audio tab and click the Browse button.
3. In the file browser window, select the audio WAV file track to be used.

To view the Audio Waveform in Fusion Studio, do the following:

1. Open the Keyframes Editor.
2. Expand the Saver track to view the audio waveform.

When you want to find the precise location of an audio beat, transient, or cue, you can slowly drag over the audio waveform to hear the audio.
Chapter 65

Rendering Using Saver Nodes

This chapter covers how to render compositions using Saver nodes in Fusion Studio and the Fusion page in DaVinci Resolve. It also covers how to render using multiple computers over a network when using Fusion Studio.

Contents

| Rendering Overview                  | 1064 |
| Rendering in the Fusion Page        | 1064 |
| Rendering in Fusion Studio          | 1065 |
| Rendering with the Saver Node       | 1065 |
| Setting Filenames for Export        | 1066 |
| Using the Render Settings Dialog    | 1067 |
| Render Settings Dialog Options      | 1068 |
| Rendering Previews                 | 1069 |
| Setting Up Network Rendering in Fusion Studio | 1069 |
| Licensing for Network Rendering     | 1070 |
| Configuring the Render Master and Render Nodes | 1071 |
| Setting Up the Render Manager       | 1073 |
| Submitting Comps to Network Render  | 1074 |
| Using the Render Settings Dialog for Network Rendering | 1074 |
| Using the Render Manager Window for Network Rendering | 1075 |
| Working with Node Groups            | 1076 |
| Viewing the Render Log              | 1077 |
| Using Third-Party Render Managers with Fusion Studio | 1077 |
When you have finished creating a composition in Fusion, you need to render the files out to disk for playback and integration into a larger timeline. Fusion Studio and the Fusion page in DaVinci Resolve use very different workflows for rendering. To finish a composite in the Fusion Page, you use a MediaOut node to cache the results into the Edit or Cut page Timeline. The DaVinci Resolve Deliver page handles the final render of the entire Timeline. To get completed composites out of Fusion Studio, you configure and render them starting with a Saver node in the Node Editor. Fusion Studio is also capable of distributing a variety of rendering tasks to other machines on a network.

Rendering in the Fusion Page
In the Fusion page, a MediaOut node is required for getting your composite from the Fusion page back into the Edit or Cut page Timeline. Whatever the MediaOut node displays when you see it in the viewer is what gets rendered back into the Edit or Cut page. This process is semi-automatic in DaVinci Resolve, where the Smart Render Cache setting begins caching the MediaOut node almost immediately when you return to the Edit or Cut page Timeline. The cache file format and any resolution scaling to fit the composition into the Timeline Resolution is handled in the DaVinci Resolve Project Settings.
Rendering in Fusion Studio

In Fusion Studio, all rendering goes through Saver nodes. Similar to MediaOut nodes in the Fusion page, Saver nodes are most often appended to the end of a node tree to render the final composite. The Saver node determines the name, format, and location of the rendered files.

Rendering with the Saver Node

To begin rendering in Fusion Studio, you must add at least one Saver node to the node tree. Most of the time, you will place at least one Saver node at the very end of your tree to render the final image.

A single Saver node is added to the end of a node tree to render the final composite.

You can attach multiple Saver nodes anywhere along the node tree to render out different parts of a composite. In the example below, three Saver nodes are added at different points in the node tree. The top two render out each half of the composite while the bottom renders the results of the entire composite.

Multiple Saver nodes can be added to different parts of a node tree.

You can also use multiple Saver nodes stemming from the same node in order to create several output formats. The below example uses the three Savers to export different formats of the same shot.
Multiple Saver nodes can be added to create different formats for output.

Adding a Saver node to a node tree automatically opens a Save dialog where you name the file and navigate to where the exported file is saved. You can then use the Inspector to configure the output format.


**Setting Filenames for Export**

If you use a file extension when naming the file, Fusion will set the output format accordingly. For example, naming your file image_name.exr will set the Inspector to output an EXR file or naming a file image_name.mov will set the Inspector for an H264 QuickTime movie. If you decide to change or modify the setting of the file type, the Saver’s format tab in the Inspector contains the specific parameters for the selected format.

If you decide to output an image sequence, a four-digit frame number is automatically added before the filename extension. For example, naming your file image_name.exr results in files named image_name0000.exr, image_name0001.exr, and so on. You can specify the frame padding by adding several zeroes to indicate the number of digits. For example, entering a filename as image_name_000.exr results in a sequence of images with the names Image_name_000.exr, Image_name_001.exr, Image_name_002.exr, and so on.

**NOTE:** The starting frame number always uses the Time Ruler start frame number.
Using the Render Settings Dialog

In Fusion Studio, you initiate rendering by clicking the Render button and opening the Render Settings dialog. This dialog configures the quality, frame range, and network usage of the rendering.

To Render a comp in Fusion Studio:

1. Connect a Saver node at the end of your composition.
2. Enter a name and a location for the saved file(s) in the Save window.
3. Set the format using the Format tab in the Inspector, if necessary.
4. Click the Render button in the transport controls area or choose File > Render All Savers.

The Render Settings dialog opens providing options for the rendered output.

Ensure that the frame range and other parameters are correct and click Start Render.

Saver nodes in the DaVinci Resolve Fusion page

The Fusion page also includes a Saver node, although it is used for a different purpose than the Saver node in Fusion Studio. Rendering from the Fusion page is handled primarily through the MediaOut node. There is no Render Settings dialog since the rendering location and format is predetermined by DaVinci Resolve’s cache settings. Saver nodes in the Fusion page are a special case, and are used to render OpenEXR files only. Once you add a Saver node, you enter the filename with the extension .exr. Click the Browse button to select a location for the EXR sequence, and then choose Fusion > Render All Savers.

Using the Saver node is useful for optimizing extremely complex and processor-intensive compositions. For example, you can render out specific branches of a node tree that no longer requires frequent adjustment to OpenEXR via a Saver node, and then reimport the result to take the place of the original branch of nodes in order to improve the performance of your composition.

Alternatively, you can render out multi-channel mattes or EXR images containing Arbitrary Output Variables (AOVs) to bring into other applications.
Render Settings Dialog Options

Many of the options in the Fusion Studio Render Settings dialog are used when you need to create a quick preview or a test render. The options in this dialog allow you to increase performance by disabling some of the image-processing operations that are time consuming but deliver higher quality results. Often the first settings you set are those in the Configurations section. This section determines whether you want to produce a final high quality render or a faster preview render. Selecting Final prevents you from modifying the options that will limit the quality.

Settings

When the Configuration section is set to Preview, the Settings section of the Render dialog includes three options that determine the overall quality and appearance of your final output. These buttons also have a significant impact on render times. When the Configurations setting is set to Final, these options cannot be disabled.

- **HiQ**: When enabled, this setting renders in full image quality. If you need to see what the final output of a node would look like, then you would enable the HiQ setting. If you are producing a rough preview to test animation, you can save yourself time by disabling this setting.

- **MB**: The MB in this setting stands for Motion Blur. When enabled, this setting renders with motion blur applied if any node is set to produce motion blur. If you are generating a rough preview and you aren’t concerned with the motion blur for animated elements, then you can save yourself time by disabling this setting.

- **Some**: When Some is enabled, only the nodes specifically needed to produce the image of the node you’re previewing are rendered.

Size

When the Configurations section is set to Preview, you can use the Size options to render out frame sizes lower than full resolution. This is helpful when using the Render dialog to create proxies or just creating a smaller file size.

Network

The Network setting controls the distribution of rendering to multiple computers. For more information, see the network rendering section in this chapter.

Shoot On

Again, this option is only available when Configurations is set to Preview. The Shoot On setting allows you to skip frames when rendering. You can choose to render every second, third, or fourth to save render time and get faster feedback. You can use the Step parameter to determine the interval at which frames are rendered.

Frame Range

Regardless of whether the Configurations is set to Final or Preview, this option defaults to the current Render In/Out Range set in the Time Ruler to determine the start and end frames for rendering. You can modify the range to render more or fewer frames.

Configurations

When set to Final, the Render Settings are set to deliver the highest quality results, and you cannot modify most of the options in this dialog. When set to Preview, you can set the options to gain faster rendering performance. Once you’ve created a useful preview configuration, you can save it for later use by clicking the Add button, giving it a name, and clicking OK.
Rendering Previews

You can render Flipbook previews into a viewer. These Flipbook previews exist entirely within RAM. They are created by right-clicking over a node in the Node Editor and choosing Create > Play/Preview on > Left viewer/Right viewer from the drop-down menu. The Render Settings dialog appears where you can configure the preview and initiate the rendering. You can also Option-drag a node directly from the Node Editor into a viewer. The Render Settings dialog will be displayed, and the preview will appear on the viewer you target.

For more information on rendering RAM previews, see Chapter 68 "Using Viewers" in the DaVinci Resolve Reference Manual or Chapter 7 in the Fusion Reference Manual.

**TIP:** Option-Shift-dragging a node into a viewer will skip the Render dialog and previously used settings.

Setting Up Network Rendering in Fusion Studio

Fusion Studio is capable of distributing a variety of rendering tasks to an unlimited number of computers on a network, allowing multiple computers to assist with creating network-rendered previews, disk caches, and final renders.

Using the Render Settings dialog or the built-in Render Manager, you can submit compositions to be rendered by other copies of Fusion Studio, as well as to one or more Fusion Render nodes. Rendering can also be controlled through the command line for integration with third-party render managers like Deadline, Rush, and Smedge.

Render nodes are computers that do not have the full Fusion application installed but do have Fusion Render Node software installed. The Render Node software is not installed by default when you install Fusion Studio, but it can be installed at any time using the Fusion Render Node Installer. The installer is located in the Blackmagic Fusion Studio installer.dmg on macOS and the Blackmagic Fusion Studio.zip on Linux and Windows. Fusion Studio is licensed for an unlimited number of Render nodes, so you can install the Render Node software on as many macOS, Windows, and Linux computers that you want involved in network rendering.

To install a Render node:

1. Download and unzip the Blackmagic Fusion Studio archive. Then locate the Render Node Installer.
2. Copy the Install Fusion Render Node [version] to each computer on the network that you want to perform rendering operations.
3. Install the Render node.

By default, the Render Node application will be added to the Start Menu on Windows under Blackmagic Design. On macOS, it is added to the menu bar, and on Linux it appears in the app launcher. Each time you log in to the computer, the Render Node application will run automatically.

To disable the Render Node application from starting up automatically, choose Quit from the Render Node icon in the macOS menu. On Linux, right-click over the icon and choose Kill Process, and on Windows, delete the shortcut from the Windows Startup directory.
Licensing for Network Rendering

Most versions of Fusion Studio are licensed by connecting a single-seat hardware key (dongle) to the same computer where Fusion is installed. Each dongle includes an unlimited number of cross-platform Render Node licenses, which you can install on as many macOS, Windows, and Linux computers as you need. For Fusion Studio to access the Render Nodes, the computer with the Fusion Studio dongle needs to be on the same local network subnet as the Render Nodes. The network licensing does not require individual license files; instead, the Render Nodes automatically search for the dongle on the subnet, making it easy to set up. Single-seat dongles do not “float” over a network; they must be connected to the same computer where Fusion Studio operates.

Multi-License Dongles

Using a multi-license dongle, you can license 10 copies of Fusion Studio by connecting the dongle to any computer on the same subnet. Since these licenses “float” over a network, Fusion Studio does not have to be running on the same computer where the dongle is connected. As long as Fusion Studio is on the same subnet, it can automatically find the license server and check out an available license.

Multi-seat dongles can be combined together to tailor the number of Fusion seats in a larger facility. For example, three dongles each licensed for 10 Fusion Studios would serve up 30 licenses. This also allows for redundancy. For instance, in the example above, three computers can act as license servers. If the first server fails for some reason, Fusion Studio will automatically try the next server. Alternatively, multiple dongles can also be plugged into a single computer.

Setting Up a License Server

Setting up the license for network rendering begins by connecting either a single-seat or multi-seat dongle to a computer that will act as the host for the license server. The Render Node installer installs Fusion Server, which acts as the license server, although the Render Node does not have to run on that same computer. The Fusion Server is set up to launch at startup and run unobtrusively in the background as a service/daemon, ready to serve licenses and Fusion bins. The Fusion Server is used to serve up multiple licenses so it must be running whenever you want to operate Fusion Studio or use the Render Nodes for network rendering. Its default is to start up automatically and remain running as long as a license is being used by another computer or a Render Node is operating. If nothing is using the Fusion Server, it will quit after 30 seconds.

You will need your network administrator to set firewall rules allowing the Fusion Server, FusionScript, and the Fusion Render Node applications to communicate and confirm licensing with the computer that has the Fusion Studio dongle.

If for some reason you remove a dongle or the network drops out, the licenses of any connected Fusion Studio application will also drop. Upon losing its license, Fusion Studio will start searching for another license, locally or on a different machine. If no license is found, Fusion pauses rendering and displays a dialog with options to retry the search or autosave the comp and quit. Render Nodes only check for a license on the network once during startup, so they are not affected by removing the dongle or network issues.

Setting Up a License Server with Environment Variables

Environment variables provide a way to specify flexible or “variable” configuration options. When network rendering with Fusion, environment variables can be useful for temporarily setting a location or choosing a preference file. Using the FUSION_LICENSE_SERVER environment variable, you can set different locations for the File Server.

Instead of looking in a single location for the Fusion Server, you can set up multiple license servers separated by semicolons. For instance, fu:SetPrefs("Global.EnvironmentVars.FUSION_LICENSE_SERVER", "192.168.112; 192.168.10.55;*"")

You can also use the environment variable to scan for license servers within a subnet—for example, "bobs-mac.local;10.0.0.23;*;license.mystudio.com". Including an asterisk (*) indicates a broadcast search of the local subnet.
Like most environment variables, you can put the license server in the Global Preferences via the Prefs text file. EnvironmentVars: fu:SetPrefs("Global.EnvironmentVars. FUSION_LICENSE_SERVER", "10.0.0.23;"); fu:SavePrefs()


**NOTE:** The use of straight quotes (" ") in the environment variables above are intentional and should not be replaced with typographer’s, or curly, quotes (" ").

### Configuring the Render Master and Render Nodes

There are two roles played by computers involved in network rendering.

- The Render Master manages the list of compositions to be rendered (the queue) and allocates frames to Render Nodes for rendering. Metaphorically speaking, the Render Master is the traffic cop of this process.

- The Render Nodes are the main computers used for the rendering process. All computers involved in network rendering must be on the same network subnet, and they all must have access to the various files (including Fonts and third-party plug-ins) used to create the composite. The path to the files must be the same for each computer involved in rendering.

### Preparing the Render Master

The Render Master manages the list of compositions to be rendered (the queue) and allocates frames to Render Nodes for rendering. The Render Master is also used to maintain the Render Node list and to push updates to the various Render Nodes when needed. At least one computer in the render farm must be configured to act as the Render Master.

Any copy of Fusion can act as a Render Master by setting up the Fusion Network Preferences.

![The Network panel sets up computers as Render Masters.](image)
Acting as a Render Master has no significant impact on render performance. The system resources consumed are insignificant. However, there are specific steps you must take to make one of your computers a Render Master.

To set up the Render Master:

1. Install a copy of Fusion Studio on the computer you want to be the Render Master.
2. In Fusion Studio, choose Fusion Studio > Preferences on macOS or File > Preferences on Windows and Linux.
3. In the Preferences dialog, select the Global > Network Preferences panel.
4. Enter the name of the Render Master in the Name field and enter the IP address.
5. Enable the Make This Machine a Render Master checkbox.
6. If you want to use this computer as part of the render farm, enable the Allow This Machine to Be Used as a Network Slave checkbox as well.

**To have the Render Node act as the Render Manager:**

- Select a node in the Render Manager and choose Set Default Master from the contextual menu.

Once a computer is enabled to act as the master, use the Render Manager to add the Render Nodes it will manage. The Render Manager dialog is described in detail later in this chapter.

**Preparing Render Nodes**

Before you can begin rendering on the network, the Render Nodes must be set up to accept instructions from the Render Master.

**In Fusion Studio, you can enable the computer to be used as a Render Node in two ways:**

- Choose File > Allow Network Renders.
- Enable the Allow This Machine to Be Used as a Network Slave in the Global > Network Preferences.

**On a macOS Render Node computer:**

- Click the Render Node icon in the menu bar and choose Allow Network Renders.

![The Render Node menu accessed in the macOS menu bar](image)

**On a Linux Render Node computer:**

- Right-click the Fusion Render Node icon in the App Launcher and choose Allow Network Renders.

**On a Windows Render Node computer:**

- Right-click the Fusion Render Node icon in the taskbar Notification area and choose Allow Network Renders.
Setting Up the Render Manager

The Render Manager window is used to monitor the progress of rendering. It can be used to reorder, add, or remove compositions from a queue, and to manage the list of Render Nodes used for rendering. To open the Render Manager window in Fusion Studio, choose File > Render Manager.

The Render Manager is used to reorder, add, and remove compositions from a render queue.

The Render Master is always listed as the first computer in the Slave list along the right side. This allows the Render Manager to render local queues without using the network. For the Render Master to control additional Render Nodes, the nodes must be added to the Slave list.

Right-clicking in the Slave list allows you to add Render Nodes by entering the Render Node’s name or IP address. You can also choose Scan to have the Render Manager look for Render Nodes on the local network.

Scanning for Render Nodes

With the Render Manager open, you can scan for Render Nodes by choosing Slave > Scan for Slaves in the menu bar or by right-clicking in the Render Manager’s Slave list and choosing Scan for Slaves from the drop-down menu.

Scanning searches IP addresses on the subnet for active Render Nodes.
Scanning looks through all IP addresses on the network subnet to determine whether any other computers in the local network are actively responding on the port Fusion uses for network rendering. A copy of the Fusion Render Node must be running on the remote computer in order for it to be detected by the scan.

Manually Adding Render Nodes
To manually add a Render Node to the Slave list, select Add Slave from the Slave menu or right-click in the Render Manager’s Slave list and choose Add Slave from the drop-down menu. The Add Slave dialog allows you to manually enter a Render Node name or IP address to locate it on the subnet.

In the Add Slave dialog that opens, enter the name or the IP address of the remote Render Node. The Render Manager will attempt to resolve names into IP addresses and IP addresses into names automatically. You can use this method to add Render Nodes to the list when they are not currently available on the network.

Removing Render Nodes
To remove a computer from the Slave list, select the Render Node in the list and choose Slave > Remove Slave(s) or right-click over the Render Node in the Slave list and choose Remove Slave(s) from the pop-up menu. You can use Command on macOS or Ctrl on Windows and Linux to select multiple Render Nodes for removal.

Loading and Saving Render Node Lists
The list of Render Nodes is automatically saved in the Documents > Blackmagic Design > Fusion > Queue folder when you quit the Render Manager. You can save and reload alternative lists of Render Nodes by choosing Slaves > Save Slave List and Load Slave list from the menu.

Submitting Comps to Network Render
To submit a comp to render on the network, you can use the Render Manager, the Render Settings dialog, or a third-party render farm application. The Render Settings dialog is quicker, while the the Render Manager and third-party render farm applications can provide more feedback and control over the process.

Using the Render Settings Dialog for Network Rendering
When starting a preview or a final render, selecting the Use network checkbox from the Render Settings dialog and submitting the render adds a composition to the end of the current queue in the Render Manager. The Render Master used is based on the Fusion preferences from the workstation submitting the comp.
The Use Network checkbox enables network rendering from the Render Settings dialog.

**NOTE:** Distributed network rendering works for image sequences like EXR, TIFF, and DPX. You cannot use network rendering for Quicktime, H264, ProRes, or MXF files.

### Using the Render Manager Window for Network Rendering

The Render Manager uses a render queue that lets you batch render comps. Compositions are rendered in the order in which they’re listed in the Render Manager, with the top entry rendered first, followed by the next item down, and so on. Multiple comps in a queue may render simultaneously depending on the group of Render Nodes they are using and the priority assigned to each comp.

**To add a comp to the queue in the Render Manager:**

- Click the Add Comp button and navigate to the comp on your hard drive.
- Right-click in the queue list and select Add Comp from the drop-down menu, and then navigate to the comp on your hard drive.
- Drag a comp file from an OS window into the Render Manager’s queue list.

The Add Comp button in the Render Manager adds a comp to the queue for batch rendering over the network.

### Removing a Composition from the Queue

To remove a composition from the queue, select the composition in the queue list and press the Backspace/Delete key or right-click over the comp in the queue list and choose Remove Composition from the drop-down menu.

### Saving and Reloading Queue Lists

It can be useful to save a queue list to reuse at a later time. The current queue list is saved in the Documents > Blackmagic Design > Fusion > Queue folder. To save the current queue with a new name, choose File > Save Queue As in the Render Manager menu bar. To reload a saved Queue, choose File > Load Queue and navigate to the saved location.

### Reordering the Queue Lists

In the middle of a job, priorities for finishing a composition may change. Shifting deadlines may require that a composition further down in the queue be rendered sooner. You can move comps to a new position in the queue by dragging them in the queue list. If a composition with a status set to Done is moved lower in the queue, it does not re-render. To re-render a comp, right-click on the comp in the queue and choose Clear Completed frames from the drop-down menu.
Working with Node Groups

Render Nodes can be configured into Groups, which are then used when submitting compositions. For example, imagine you have five Render Nodes. All the Render Nodes are members of the group named All. Two of the Render Nodes include more memory and faster processors, so you create a new group called Hi-Performance.

New Render Nodes are automatically added to All, but you can assign them to other groups as well.

To assign a Render Node to a Group:
1. Open the Render Manager and select the Render Nodes to assign to a group.
2. Choose Slave > Assign Group or right-click over the Render Nodes and choose Assign Group from the drop-down menu.
3. In the Choose Group dialog, enter a name for the group.
4. To assign Render Nodes to multiple groups, separate the name of each group using a comma (e.g., All, Local, or Hi-Performance). The order of the groups determines the priority. See “Using Multiple Groups” below.

When a render is submitted to the network, it is automatically sent to the All group. However, you can choose to submit it to other groups in the list.

To submit a comp to a group from the Render Manager:
1. Open the Render Manager.
2. Submit the comp.
3. Click the Pause Render button.
4. Right-click over the comp in the queue list and select Assign Group.
5. In the Assign Group dialog, select an existing group to render the comp and click OK.
6. Click the Resume Render button.

To submit a comp to a group from the Render Settings dialog:
1. Click the Render button in the transport controls area.
2. In the Render Settings dialog, enable the Use Network checkbox.
3. Select an existing group from the Available groups list.
4. Click the Start Render button.

Continuing with the group example above, five Render Nodes are contained in the All group, and two of those Render Nodes are also in the Hi-Performance group. If you submit a render to the Hi-Performance group, only two of the computers on the network are used for rendering. If a composition is then submitted to the All group, the remaining three machines will start rendering the new composition. Once the two Render Nodes in the Hi-Performance group complete the first job, they join the render in progress on the All group.

Groups are optional and do not have to be used. However, groups can make managing large networks of Render Nodes easier and more efficient.
Using Multiple Node Groups

A single Render Node can be a member of multiple groups. A single composition can also be submitted to multiple groups. Submitting a composition to multiple groups results in it rendering on all Render Nodes in the selected groups.

When a Render Node is a member of multiple groups, the order of the groups is important because the order defines the priority for that Render Node.

For example, if groups are assigned to a Render Node as All, Hi-Performance, then renders submitted to the All group take priority. Any renders in progress that were submitted to the Hi-Performance group will be overridden. If the order is changed to Hi-Performance, All, then the priority is reversed.

Viewing the Render Log

The Render Log is displayed in the lower half of the Render Manager window, although it can also be displayed in the console window. The text in the log displays the Render Manager activities, including which frame is assigned to which Render Node, which Render Nodes have loaded the compositions in the queue, and statistics for each render after completion.

To view the Render Log in the console:

- Open the Render Manager and choose Misc > Show Render Log.

There are two modes for the Render Log: a Verbose mode and a Brief mode. Verbose mode logs all events from the Render Manager, while Brief mode logs only which frames are assigned to each Render Node and when they are completed.

To disable Verbose mode:

- Choose Misc > Verbose Logging from the Render Manager’s menu bar.

Using Third-Party Render Managers with Fusion Studio

You can make use of third-party render manager software to control network rendering. This allows for efficient sharing of your computer resources between the many applications that may make use of them. Examples of such managers are Smedge from Uberware LLC, Rush from Seriss, and Deadline from GetRender. Generally, these render managers use a command line renderer. By default, Fusion’s Render Nodes operate as a service to the Fusion internal render manager. However, you can also run the Render Nodes via the command line for third-party render managers.

Keep in mind that using a third-party render manager will prevent the use of some of Fusion’s network rendering features, such as the ability to create network rendered Flipbook Previews and disk caches.

Command Line Rendering

For studios using third-party render farm managers like Deadline, Smedge, or Rush, the Fusion Render Node can be called via command line passing arguments and file paths. In this Windows example, a Render Node is called to load a composition called exampleV001, and render 10 frames:

```
//pathtoRN/FusionRenderNode.exe //pathtoProject/exampleV001.comp -render -start 101 -end 110 -quit
```

This would start up, render frames from 101 to 110, and then quit.
The following table lists additional command line features.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Fusion Server -i”</td>
<td>Installs the license server as a service or daemon, launching it on startup before user login.</td>
</tr>
<tr>
<td>“Fusion Server -S” (capital S)</td>
<td>Causes the Fusion Server to run persistently in the background, until force-quit.</td>
</tr>
<tr>
<td>&lt;filename.comp&gt;</td>
<td>Full path and comp name, like /storage/project/episode/shot/filename.comp.</td>
</tr>
<tr>
<td>-render</td>
<td>Tells the Render Node to render.</td>
</tr>
<tr>
<td>-frames &lt;frameset&gt;</td>
<td>Passes a series of frame ranges to be rendered—e.g., 101..110,120,121,130..150.</td>
</tr>
<tr>
<td>-start &lt;frame&gt;</td>
<td>Sets the start frame of the render.</td>
</tr>
<tr>
<td>-end &lt;frame&gt;</td>
<td>Sets the last frame of the render.</td>
</tr>
<tr>
<td>-step &lt;step&gt;</td>
<td>Normally set to 1, step skip frames for rendering. For instance, 2 would render every second frame.</td>
</tr>
<tr>
<td>-quit</td>
<td>Causes the Render Node to quit after the render is complete.</td>
</tr>
<tr>
<td>-join &lt;host&gt;</td>
<td>Prompts the node to connect to a manager at &lt;hostname,IP&gt;, and (re)join any ongoing renders.</td>
</tr>
<tr>
<td>-listen</td>
<td>The node remains running and waits for incoming requests from a manager.</td>
</tr>
<tr>
<td>-log &lt;filename&gt;</td>
<td>Causes the Render Node to output information about the render to a log file. This appends to the end of an existing log file.</td>
</tr>
<tr>
<td>-cleanlog</td>
<td>Clears existing text from a log file.</td>
</tr>
<tr>
<td>-verbose</td>
<td>Outputs more detailed information into the log file.</td>
</tr>
<tr>
<td>-quiet</td>
<td>Suppresses pop-ups and interface buttons from displaying and needing interaction.</td>
</tr>
<tr>
<td>-version</td>
<td>Returns the Render Node version number.</td>
</tr>
<tr>
<td>-pri high</td>
<td>above</td>
</tr>
<tr>
<td>-args &lt;arg1&gt; [, &lt;arg2&gt; ...]</td>
<td>Allows storing custom values that can be fetched by calling the script function GetArgs(), which will return a table of ( &lt;arg1&gt;, &lt;arg2&gt;, ...)</td>
</tr>
</tbody>
</table>

**TIP:** An X11 virtual frame buffer is required to make a headless Linux command line interface work.
Preparing Compositions for Network Rendering

The way you construct a composition in Fusion Studio can help or hinder network rendering. The media you read in, where plug-ins are installed, and the mix of operating systems on your networked computers all play a part in how smoothly your network rendering goes. Your setup must include several essential parts before network rendering will work:

- License dongle, Render Master, and Render Nodes must be on the same local network (subnet).
- Fusion Server must be running as a background service on the same computer where the dongle is installed.
- All source media from the comp should be placed on a network volume.
- The network volume must be mounted on each Render Node.
- Loaders must point to the media on the mounted volumes.
- Savers must write to a drive that is mounted on each render node.
- The Fusion comp must be saved to a volume that is mounted on each Render Node.
- All Render Nodes and Render Masters need read and write access to any volumes specified as a source media location or render destination.
- Make sure all fonts used in the comp for Text+ and 3D text nodes are installed on all the Render Nodes.
- Make sure all Render Nodes have third-party OFX plug-ins installed if any are used in the comp.

Below are more details about some of these items.

Using Relative Paths

The file paths used to load a composition and its media, and to save the composition’s rendered results, are critical to the operation of network rendering. Each computer used for network rendering must be able to access the media location for each Loader in the comp. Savers must be set up to save to folders that all Render Nodes can see and to which all Render Nodes have write permission. Even the composition must be saved in a folder accessible to all Render Nodes, and it should be added to the queue list using a path that’s visible to all Render Nodes.

For example, if you open a composition located at c:\compositions\test1.comp in Fusion Studio and add the composition to the network rendering queue, the Render Manager sends a message to each Render Node to load the composition and render it. The problem is that each computer is likely to have its own c:\drive that does not contain the comp you created. In most cases, the Render Nodes will be unable to load the composition, causing it to fail.

Path Maps located in Fusion Preferences are virtual paths used to replace segments of file paths. They can change the absolute paths used by Loader and Saver nodes to relative paths. There are a number of Path Maps already in Fusion, but you can also create your own. The most common path to use is the Comp:\ path.

Comp\ is a shortcut for the folder where the actual composition is saved. So, using Comp\ in a Loader makes the path to the media file relative, based on the saved location of the comp file. As long as all your source media is stored in the same folder or subfolder as your comp file, Fusion locates the media regardless of the actual hard drive name.
Here’s an example of a file structure that enables you to use relative file references. The composition is stored in the following file path:

Volumes\Project\Shot0810\Fusion\Shot0810.comp

And your source media is stored here:

Volumes\Project\Shot0810\Fusion\Greenscreen\0810Green_0000.exr

This overall directory structure can be seen in the following screenshot:

File paths can use relative paths based on the location of the saved comp file.

In this situation, using the Comp:\ path means your media location starts from your comp file’s location. The relative path set in the Loader node would then be:

Comp:\Greenscreen\0810Green_0000.exr

Replacing the Loader’s path to start with Comp:\ creates a relative path from the comp file’s location.

If your source media’s actual file path uses a subfolder in the same folder as the comp file’s folder:

Volumes\Project\Shot0810\Footage\Greenscreen\0810Green_0000.exr

The relative path set in the Loader node would then be:

Comp:\..\Footage\Greenscreen\0810Green_0000.exr

The two dots .. instruct the path to go up one folder.

**TIP:** Some Path Maps are not set up on a Fusion Render Node automatically. For instance, you must manually add an entry for macros if you are using macros in your comp.

### Using Mapped Drives

Having the comp and media set to relative paths solves only part of the problem. Each computer involved in rendering needs to have access to the drive where the comp and source media are located. Mapping a drive provides permanent access to a folder on another computer or network storage device.

Windows assigns a new drive letter to the folder, and it can be accessed just like any other drive connected to your computer. Mapped drives assign a letter of the alphabet to a shared network resource. Your shared drives must be the same drive letters on all Render Nodes. For example, if your media is on drive Z, then the network drive must appear as the letter Z on each of the Render Nodes.
On macOS, you can map a network drive using Connect to Server from the Go menu. Entering the smb:// path to the drive will mount it on the computer. Using Accounts > Login Items, you can have the network drive auto-mount after a reboot as well.

**Installing All Fonts on Render Nodes**

All fonts used by Text tools in the composition must be available to all nodes participating in the render. The render will otherwise fail on the slaves that do not have the font installed.

**Installing Third-Party Plug-Ins on Render Nodes**

All third-party plug-ins and tools used by a composition must be installed in the plug-ins directory of each Render Node. A Render Node attempting to render a composition that uses a plug-in that’s not installed will fail to render. Licensed plug-ins are required on each Render Node.

**Other Uses of Network Rendering**

Although you will probably set up network rendering for the purpose of accelerating the output of your final renders, Fusion is capable of using the network for other purposes as well. You can use the nerdier nodes on your network to accelerate the creation of Flipbook Previews and disk caching as well.

**Flipbook Previews**

Fusion Studio is able to use Render Nodes to accelerate the production of Flipbook Previews, allowing for lightning fast previews. Frames for previews that are not network rendered are rendered directly into memory. Select the Use Network checkbox and the Render Nodes to render the preview frames to the folder set in the Preferences Global > Path > Preview Renders. This folder should be accessible for all Render Nodes that will participate in the network render. The default value is Temp/, which is a virtual path pointing to the system’s default temp folder. This will need to be changed before network rendered previews can function. Once the preview render is completed, the frames that are produced by each Render node are spooled into memory on the local workstation. As each frame is copied into memory, it is deleted from disk.

**Disk Cache**

Right-clicking a node in the Node Editor and choosing Cache to Disk opens a dialog used to create the disk cache. If you enabled the Use Network checkbox and click the Pre-Render button to submit the disk cache, the network Render Nodes are used to accelerate the creation of the disk cache.

![Disk cache on *ColorCorrector*](image)

Render Nodes can be used for disk caching as well as final renders.
When Renders Fail

It is a fact of life that render queues occasionally fail. The composition has an error, the power goes out, or a computer is accidentally disconnected from the network are some causes for failure. If no one is available to monitor the render, the risk that an entire queue may sit inactive for several hours may become a serious problem.

Fusion Studio includes a variety of measures to protect the queue and ensure that the render continues even under some of the worst conditions.

Automatic Rejoining of the Queue

If a Render Node becomes unavailable to the Render Master for any reason, frames assigned to that Render Node are reassigned among the remaining Render nodes in the list.

When the Render Node becomes available for rendering again, it will signal the Render Master that it is ready to render again, and new frames will be assigned to that Render Node.

This is why it is important to set the Render Master in the network preferences of the Render Nodes. If the master is not set, the Render Node will not know what master to contact when it becomes available.

In the Fusion Render Node Preferences, select the Tweaks panel. Using the Last Slave Restart Timeout field, you can enter the number of seconds Fusion waits after the last Render Node goes offline before aborting that queue and waiting for direct intervention.

Relaunching Render Nodes with Fusion Server

Fusion Server is a small utility installed with Fusion Studio and the Render Node. The application is silently launched by each Fusion Render Node when started.

Fusion Server monitors the Render Node to ensure that the Render Node is still running during a render. It consumes almost no CPU cycles and very little RAM. If the monitored Render Node disappears from the system’s process list without issuing a proper shutdown signal, as can happen after a crash, the Fusion Server relaunches the Render Node, allowing it to rejoin the render.

Fusion Server will only detect situations where the Render Node has exited abnormally. If the Render Node is still in the process list but has become unresponsive for some reason, the Fusion Server cannot detect the problem. Hung processes like this are detected and handled by frame timeouts, as described below.

Frame Timeouts

Frame timeouts are a fail-safe method of canceling a Render Node's render if a frame takes longer than the specified time (with a default of 60 minutes, or one hour). The frame timeout ensures that an overnight render will continue if a composition hangs or begins swapping excessively and fails to complete its assigned frame.

The timeout is set per composition in the queue. To change the timeout value for a composition from the default of 60 minutes, right-click on the composition in the Render Manager’s queue list and select Set Frame Timeout from the contextual menu.
Right-click over a comp in the Render Manager to set a timeout value.

To change the frame timeout value, choose Set Frame Time Out from the Render Manager’s Misc menu and enter the number of seconds you want for the Time Out.

**Heartbeats**

Often, the network environment is made up of computers with a variety of CPU and memory configurations. The memory settings used on the workstation that created a composition may not be appropriate for all the Render Nodes in the network. The Render Node software offers the ability to override the memory settings stored in the composition and use custom settings more suited to the system configuration of a specific Render Node.

The number of heartbeats in a row that must be missed before a Render Node is removed from the list by the manager, as well as the interval of time between heartbeats, can be configured in the Network Preferences panel of the master. The default settings for these options are fine for 90% of cases.

If the compositions that are rendered tend to use more memory than is physically installed, this will cause swapping of memory to disk. It may be preferable to increase these two settings somewhat to compensate for the sluggish response time until more RAM can be added to the slave.

**Managing Memory Use**

Often, the network environment is made up of computers with a variety of CPU and memory configurations. The memory settings used on the workstation that created a composition may not be appropriate for all the Render Nodes in the network. The Render Node software offers the ability to override the memory settings stored in the composition and use custom settings more suited to the system configuration of a specific Render Node.

To access preferences for a node, right-click on the icon in the Windows Notification area or from the macOS menu bar and choose Preferences. In the Preferences dialog, select the Memory panel.

**Override Composition Settings**

Enable this option to use the Render Node’s local settings to render any incoming compositions. Disable it to use the default settings that are saved into the composition.

**Render Several Frames at Once**

Fusion has the ability to render multiple frames at once for increased render throughput. This slider controls how many frames are rendered simultaneously. The value displayed multiplies the memory usage (a setting of 3 requires three times as much memory as a setting of 1).

Normal values are 2 or 3, although machines with a lot of memory may benefit from higher values, whereas machines with less memory may require the value to be 1.
Simultaneous Branching

Enable this option to render every layer in parallel. This can offer substantial gains in throughput but may also use considerably more memory, especially if many layers are used in the composition. Machines with limited memory may need to have Simultaneous Branching disabled when rendering compositions with many layers.

Limitations of Render Nodes

There are a few important limitations to remember while setting up compositions and rendering over a network.

Time Stretching

Compositions using the Time Stretcher and Time Speed tools may encounter difficulties when rendered over the network. Speeding up or slowing down compositions and clips requires fetching multiple frames before and after the current frame that is being rendered, resulting in increased I/O to the file server. This may worsen bottlenecks over the network and lead to inefficient rendering. If the composition uses the Time Stretcher or Time Speed tools, make certain that the network is up to the load or pre-render that part of the composition before network rendering.

Linear Tools

Certain tools cannot be network rendered properly. Particle systems from third-party vendors, such as Genarts’s Smoke and Rain, and the Fusion Trails node cannot render properly over the network. These tools generally store the previously rendered result and use it as part of the next frame’s render, so every frame is dependent on the one rendered before it. This data is local to the tool, so these tools do not render correctly over a network.

Saving to Multi-Frame Formats

Multiple machines cannot render a single QuickTime file. Always render to separate sequential file formats like EXR, DPX, JPEG, and so on. Once the render is complete, a single workstation can load the image sequence in order and save to the desired compiled format.

NOTE: The above does not apply to network rendered previews, which are previews created over the network that employ spooling to allow multi-frame formats to render successfully. Only final renders are affected by this limitation.

Troubleshooting

There are some common pitfalls when rendering across a network. Virtually all problems with network rendering have to do with path names or plug-ins. Return to the "Preparing Compositions for Network Rendering" section in this chapter to review some of the essential setup requirements. Verify that all Render Nodes can load the compositions and the media, and that all Render Nodes have installed the plug-ins used in the composition.

If some difficulties persist, contact Blackmagic Design’s technical support using the support section on the Blackmagic Design website. Save a copy of the render.log file to send to technical support.
Checking the Render Log

The log file shown in the Render Manager dialog displays messages that can assist with diagnosing why a render or node has failed. The render log shows a step-by-step account of what happened (or didn’t happen) during a render. If a Render Node cannot be found, fails to load a composition or render a frame, or simply stops responding, it will be recorded here.

Check the Composition

The Render Manager's Status field in the render log indicates if a composition fails to render. Some possible causes of this are as follows:

– **No Render Nodes Could Be Found**: On the Preferences Network tab, make sure that there is at least one Render Node available, running and enabled. If all Render Nodes are listed as Offline when they are not, check the network.

– **The Composition Could Not Be Loaded**: Some Render Nodes may not be able to load a composition while others can. This could be because the Render Node could not find the composition (check that the path name of the composition is valid for that Render Node) or because the composition uses plug-ins that the Render Node does not recognize.

– **The Render Nodes Stop Responding**: If a network link fails, or a Render Node goes down for some reason, the Render Node will be removed from the active list and its frames will be reassigned. If no more Render Nodes are available, the composition will fail after a short delay (configurable in network preferences). If this happens, check the render log for clues as to which Render Nodes failed and why.

– **The Render Nodes Failed to Render a Frame**: Sometimes a Render Node simply cannot render a particular frame. This could be because the Render Node could not find all the source frames it needed, or the disk it was saving to become full or because of any other reason for which Fusion might normally be unable to render a frame. In this case, the Render Manager will attempt to reassign that failed frame to a different Render Node. If no Render Node can render the frame, the render will fail. Try manually rendering that frame on a single machine and observe what happens.

– **Check the Render Nodes**: Fusion’s Render Manager incorporates a number of methods to ensure the reliability of network renders. Periodically, the Render Manager will send signals called Heartbeats, generated at regular intervals, to detect network or machine failures. In this event, a failed Render Node’s outstanding frames are reassigned to other Render Nodes where possible. In rare cases, a Render Node may fail in a way that the heartbeat continues even though the Render Node is no longer processing. If a Render Node failed (although the Render Master may not have detected it) and you do not want to wait for the Frame Timeout, simply restart the Fusion workstation or Fusion Render Node that has hung. This triggers the heartbeat check, reassigns the frames on which that Render Node was working, and the render should continue. Heartbeats may fail if the system that is performing the render is making extremely heavy use of the Swap file or is spending an extraordinary amount of time waiting for images to become available over a badly lagged network. The solution is to provide the Render Node with more RAM, adjust memory settings for that node, or upgrade the network bandwidth.

– **Check the Network**: At the Render Master, bring up the Network tab of the Preferences dialog box and click Scan. If a Render Node is not listed as running, the Render Master will not be able to contact it for network rendering. Alternatively, bring up a command prompt and ping the Render Nodes manually. If the remote systems do not respond when they are up and running, the network is not functioning and should be examined further.
Chapter 66

Working in the Node Editor

This chapter discusses how to work in the Node Editor, including multiple ways to add, connect, rearrange, and remove nodes to create any effect you can think of.

Contents

Learning to Use the Node Editor 1088
Navigating within the Node Editor 1089
Automatic Node Editor Navigation 1089
Using the Node Navigator 1089
Node View Bookmarks 1090
Adding Nodes to a Composition 1092
Adding, Inserting, and Replacing Nodes Using the Toolbar 1092
Adding Nodes Quickly Using the Select Tool Window 1093
Adding Nodes from the Effects Library 1094
Adding, Inserting, and Replacing Nodes Using the Contextual Menu 1097
Deleting Nodes 1097
Disconnected Nodes 1097
Selecting and Deselecting Nodes 1098
Selecting Nodes 1098
The Active Node 1098
Deselecting Nodes 1098
Loading Nodes into Viewers 1099
Viewed Nodes When You First Open Fusion 1100
Node View Indicators 1100
Drag and Drop Nodes into a Viewer 1100
Using the Contextual Menu 1101
Clearing Viewers 1101
Create/Play Preview 1101
**Connecting and Disconnecting Nodes** 1101
Node Basics 1101
How to Connect Nodes 1102
Dropping Connections on Top of Nodes 1102
Identifying Node Inputs 1104
Node Order Matters 1105
Upstream and Downstream Nodes 1107
Disconnecting and Reconnecting Nodes 1107
Tracing Connections Through the Node Tree 1108
Branching 1108
**Connecting Merge Nodes** 1109
Automatically Creating a Merge Node When Adding Nodes 1110
Automatically Creating a Merge Node by Connecting Two Outputs 1110
**Connection Options and Routers** 1111
Using Routers to Reshape and Branch Connections 1112
**Swapping Node Inputs** 1113
**Extracting and Inserting Nodes** 1113
**Cut, Copy, and Paste Nodes** 1114
Cut, Copy, and Paste in the Node Editor 1114
Pasting Node Settings 1115
Copying and Pasting Nodes to and from Any Text Editor 1115
**Instancing Nodes** 1116
Using Instanced Nodes 1117
De-Instancing and Re-Instancing Specific Parameters 1118
**Keeping Node Trees Organized** 1118
Moving Nodes 1118
Renaming Nodes 1119
Changing Node Colors 1120
Using Sticky Notes 1120
Using Underlay Boxes 1121
**Node Thumbnails** 1122
Choosing Which Nodes Show Thumbnails 1122
Switching Thumbnails between Images and Icons 1123
**Finding Nodes** 1124
Performing Simple Searches 1124
Using Regular Expressions 1125
Learning to Use the Node Editor

The Node Editor (formerly called the Flow or Flow Editor) is the heart of Fusion’s compositing interface. It uses a flowchart structure called a node tree that lets you build a composition out of interconnected nodes, as opposed to using layers in a layer list. Each clip you add to the composition, and each image-processing operation you apply to those clips, is added as a node, all of which are joined together with connections that propagate image data from one node to the next. Each individual node performs a relatively simple operation, but collectively they combine to let you create wonderfully complex results.

This chapter discusses how to work in the Node Editor in greater detail, showing you how to add, connect, rearrange, and remove nodes to create any effect you can think of.

To display the Node Editor:
- Click the Nodes button on the UI toolbar.

![The Nodes button in the UI toolbar.](image)
Navigating within the Node Editor

The Node Editor is the place where everything relating to nodes and the construction of your composites happens. The more you learn about how to navigate within the Node Editor, the faster you’ll be able to work. There are a variety of standard methods of panning and zooming around the Node Editor, many of which are shared with other panels in Fusion.

Methods of panning the Node Editor:
- Middle-click and drag to pan around the Node Editor.
- Hold down Shift and Command, and then click and drag within the Node Editor to pan.
- Drag with two fingers on a track pad to pan in the Node Editor.

Methods of zooming the Node Editor:
- Press the Middle and Left buttons simultaneously and drag to resize the Node Editor.
- Hold down the Command key and use your pointer’s scroll control to resize the Node Editor.
- Right-click the Node Editor and choose an option from the Scale submenu of the contextual menu.
- Press Command-1 to reset the Node Editor to its default size.
- Hold down the Command key and drag with two fingers on a track pad to resize the Node Editor.

Automatic Node Editor Navigation

If a node that is not visible in the Node Editor becomes selected, either by using the Find command or by selecting a node’s header in the Inspector, the Node Editor will automatically pan to display the node in the visible area.

Using the Node Navigator

Another useful way to pan around the Node Editor is to use the Node Navigator. The Node Navigator is a small rectangular overview in the upper-right corner of the Node Editor. It gives a bird’s eye view of the entire composition, with an inner outline that indicates the portion of the composition that is visible in the panel. You can use the Node Navigator when you are zoomed in on a node tree and want to pan around a composition.

To display or hide the Node Navigator, do one of the following:
- Right-click in an empty area of the Node Editor, and then choose Options > Show Navigator.
- Press the V key.
To have the Node Navigator resume displaying automatically when needed after you’ve closed it:
– Right-click in an empty area of the Node Editor, and then choose Options > Auto Navigator.

To change the size of Node Navigator, do the following:
– Drag the lower-left corner of the Navigator to resize it.

![Drag the corner to resize the Navigator.](image)

To return to the default Node Navigator size, do the following:
– Right-click anywhere within the Node Navigator and choose Reset Size.

To pan the Node Editor using the Node Navigator, do the following:
– Drag within the Node Navigator to move around different parts of your node tree.
– Within the Navigator, drag with two fingers on a track pad to move around different parts of your node tree.

Node View Bookmarks

Bookmarks are another way of navigating the Node Editor. Bookmarks save the position and scale of the Node Editor, so you can quickly and precisely jump from viewing one group of nodes to viewing another.

To add a bookmark, do the following:
1 Pan and scale in the Node Editor to view a group of nodes you are interested in.
2 From the Options menu in the upper right of the Node Editor, choose Add Bookmark, or press Cmd-D.
3 In the Manage Bookmarks dialog that opens, enter a name for the bookmark and click the Add button.

The first nine saved bookmarks are given keyboard shortcuts and listed in the Options menu. They are also listed in the Go To Bookmarks dialog along with any saved bookmarks beyond the initial nine.
The Node Editor Options menu with nine bookmarks added

TIP: You can return the Node Editor to the default scale by right-clicking in the Node Editor and choosing Scale > Default Scale or pressing Cmd-1.

If your Node Tree changes and you want to update Bookmark names or delete bookmarks, those tasks can be done in the Manage Bookmarks dialog.

**To rename or delete a bookmark, do the following:**

1. From the Options menu in the upper right of the Node Editor, choose Manage Bookmarks.
2. In the Manage Bookmarks dialog that opens, right-click over the bookmark and choose Rename or Remove.
3. Click OK to close the Manage Bookmarks dialog.

Using Bookmarks

You can jump to a Bookmark view by selecting a bookmark listed in the Options menu or choosing Go To Bookmarks to open the Go To Bookmarks dialog. The Go To Bookmarks dialog has all the bookmarks listed in the order they were created in the current composition. Double-clicking on any entry in the dialog will update the Node Editor to that view and close the Go To Bookmarks dialog.

If you have a long list of bookmarks, you can use the search field at the bottom of the dialog to enter the name of the bookmark you want to find.

**Changing the Sort Order and Assigning Keyboard Shortcuts**

Bookmarks appear in the Options menu and in the Go To Bookmarks dialog in the order they were created. The top nine bookmarks listed are assigned keyboard shortcuts. If you want to change the sort order of the list you can do that in the Manage Bookmarks dialog. This can be useful if you want some bookmarks to have specific keyboard shortcuts, or you want a bookmark you made early in the process to not have a keyboard shortcut assigned to it.
To change the order of the listed bookmarks, do the following:

1. From the Options menu in the upper right of the Node Editor, choose Manage Bookmarks.
2. In the Manage Bookmarks dialog, drag a bookmark up or down in the list.
3. An insert line appears where the bookmark will be inserted. Release the mouse button when the insert line is where you want the bookmark to be listed.

The keyboard shortcuts will update to reflect the new order.

TIP: You can hold down the Shift key to select multiple bookmarks and move them simultaneously up or down in the Manage Bookmark list.

Using Underlays as Bookmarks

Underlays added to the Node Editor are automatically added as bookmarks. They are listed in the Options menu below the list of your custom bookmarks. You can omit Underlays from showing in the list of bookmarks by opening the Go To Bookmarks dialog and disabling the checkbox to Show Underlays. When the checkbox is disabled, Underlays will not show in the Go To Bookmarks dialog, and they will not appear in the Options menu.

Adding Nodes to a Composition

- You can add nodes to the Node Editor in a variety of ways, depending on the type of node you're adding, and how much guidance you need to find what you're looking for. Additionally, the way you add nodes to a composition may also be dictated by how you need to attach that node to the current node tree.

Make Sure You’re Adding Compatible Nodes

It’s a good rule of thumb to make sure that whenever you’re adding or inserting new nodes to the node tree, that you’re adding nodes that are compatible with the nodes you’re trying to attach to. For example, you’ll have no problem inserting a Blur, Color, Filter, Paint, or Position node after almost any 2D operation. However, if you try to add a Merge3D node after a Glow node, it won’t automatically connect, because those two nodes cannot be connected directly.

Adding, Inserting, and Replacing Nodes Using the Toolbar

The Fusion toolbar, located above the Node Editor, displays a selection of frequently-used nodes, displayed as buttons with distinct icons. These buttons make it fast to add Merge, Background, Paint, Mask, Transform, and many other commonly used nodes with the click of a button, or the drag of your pointer.

TIP: If you don’t know which node a particular icon corresponds to, just hover your pointer over any toolbar button and a tooltip will display the full name of that tool.
Methods of adding nodes by clicking toolbar buttons:

- **To add a node after a selected node:** Select a node in the Node Editor and then click a toolbar button.

- **To add a disconnected node to the Node Editor:** Deselect all nodes in the Node Editor and then click a toolbar button.

Methods of adding nodes by dragging toolbar buttons:

- **To insert a new node into the node tree:** Drag a toolbar button into the Node Editor and onto the connection line between any two compatible nodes. When the connection highlights as the node is over it, drop the node and it’ll be inserted.

- **To create a disconnected node:** Drag a toolbar button into an empty part of the Node Editor. Dragging a toolbar button into the Inspector also creates a disconnected node.

- **To insert a new node after a node loaded into a viewer:** Drag a toolbar button onto a viewer to insert a new node after whichever node is viewed, regardless of whether any nodes are selected.

To replace a node in the Node Editor with a node from the toolbar:

1. Drag a button from the toolbar so that it’s directly over the node in the Node Editor that you want replaced. When the node underneath is highlighted, drop the node.

2. Click OK in the dialog to confirm the replacement.

**TIP:** When you replace one node with another, any settings that are identical between the two nodes are copied into the new node. For example, replacing a Transform node with a Merge will copy the existing center and angle values from the Transform to the Merge.

Adding Nodes Quickly Using the Select Tool Window

The next fastest way of adding or inserting nodes to the Node Editor is using the Select Tool window, which lets you search for any node available to Fusion by typing a few characters. Once you learn this method, it’ll probably become one of your most frequently-used ways of adding nodes.

To use the Select Tool window to add nodes:

1. Do one of the following to determine if you want to insert a node or create a disconnected node:
   - If you want to insert a node, select a node that’s compatible with the one you’ll be creating, and the new node will be inserted after it.
   - If you want to create a disconnected node, deselect all nodes.

2. Press Shift-Spacebar to open the Select Tool dialog.

3. When the window appears, type characters corresponding to the name of the node you’re looking for. A list automatically appears with likely candidates, and you can use the Up and Down arrow keys to select the correct node (if it’s not selected already).
When you’ve selected the correct node, press the Return key (or click OK), and that node will be either inserted or added.

TIP: Whenever you use the Select Tool window, the text you entered is remembered the next time you open it, so if you want to add another node of the same kind—for example, if you want to add two Blur nodes in a row—you can just press Shift-Spacebar and then press Return to add the second Blur node.

Adding Nodes from the Effects Library

While the toolbar shows many of the most common nodes you’ll be using in any composition, the Effects Library contains every single tool available in Fusion, organized by category, with each node ready to be quickly added to the Node Editor. If you need more guidance to find the node you’re looking for, or if you just want to browse around and see what’s available, the Effects Library is the perfect place to start.

To open the Effects Library:
- Click the Effects Library button in the UI toolbar at the top of the Fusion window.

The Effects Library appears at the upper-left corner of the Fusion window, and consists of two panels. A category list at the left shows all categories of nodes and presets that are available, and a list at the right shows the full contents of each selected category.
By default, the category list shows two primary sets of effects, Tools and Templates, with disclosure controls to the left that hierarchically show all subcategories within each category. The top two categories are:

- **Tools**: Tools consist of all the effects nodes that you use to build compositions, organized by categories such as 3D, Blur, Filter, Mask, Particles, and so on. If you have third-party OFX plug-ins on your workstation, those appear in here as well.

- **Templates**: When using the Fusion page in DaVinci Resolve, templates consist of presets, macros, and utilities that have been created to get you started quickly. For example, Backgrounds consists of a variety of customizable generators that have been created using a combination of Fusion tools. Lens flares presents a wide variety of multi-element lens flares that you can add to any composition. Particles has a selection of pre-made particle systems that you can customize for your own use. Shaders has a variety of materials that you can use as texture maps for 3D text and geometry that you create in Fusion. And there are many, many other categories’ worth of useful presets and macros that you can learn from and use in your own projects.

**Adding, Inserting, and Replacing Tools Using the Effects Library**

Adding nodes to the Node Editor from the Tools category of the Effects Library is very similar to adding nodes from the toolbar.

**Methods of adding nodes by clicking in the Effects Library:**

- **To add a node after a selected node**: Select a node in the Node Editor and then click a node in the browser of the Effects Library.

- **To add a disconnected node to the Node Editor**: Deselect all nodes in the Node Editor and then click a node in the browser of the Effects Library.

**Methods of adding nodes by dragging from the Effects Library:**

- **To insert a new node into the node tree**: Drag a node from the browser of the Effects Library into the Node Editor and onto the connection line between any two compatible nodes. When the connection highlights as the node is over it, drop the node and it’ll be inserted.
– To create a disconnected node: Drag a node from the browser of the Effects Library into an empty part of the Node Editor. Dragging a toolbar button into the Inspector also creates a disconnected node.

– To insert a new node after a node loaded into a viewer: Drag a node from the browser of the Effects Library onto a viewer to insert a new node after whichever node is viewed, regardless of whether any nodes are selected.

To replace a node in the Node Editor with a node from the Effects Library:

1. Drag a node from the browser of the Effects Library so it’s directly over the node in the Node Editor that you want replaced. When that node is highlighted, drop it.

2. Click OK in the dialog to confirm the replacement.

Adding, Inserting, and Replacing Templates Using the Effects Library

Adding items from DaVinci Resolve's Fusion page Templates category is often a bit different. Sometimes, as when adding a Lens Flare, a single node can be added or inserted into the Node Editor. When this is the case, adding nodes works the same as when adding from the Tools category.

Adding a Lens Flare effect.

Other times, such as when adding an item from the “How to” category, dragging a single item from the Node Editor results in a whole node tree being added to the Node Editor. Fortunately, all nodes of the incoming node tree are automatically selected when you do this, so it’s easy to drag the entire node tree to another location in the Node Editor where there’s more room. When this happens, the nodes of the incoming effect are exposed so you can reconnect and reconfigure it as necessary to integrate the effect with the rest of your composition.

Adding a LightWrap effect from the “How to” bin of the Templates category of the Effects Library.
Adding, Inserting, and Replacing Nodes
Using the Contextual Menu

Another way of adding, inserting, and replacing nodes is to use the Node Editor’s contextual menu, which has dedicated submenus that let you create any kind of node available in Fusion. This can be a convenient when the pointer is already in the Node Editor selecting, moving, or connecting nodes.

Methods of adding nodes using the contextual menu:

– To add a node: Right-click in an empty area of the Node Editor, and choose a node from the Add Tool submenu.

– To insert a node: Right-click a node in the Node Editor, and choose a node from the Insert Tool submenu.

– To replace a node: Right-click a node in the Node Editor, and choose a node from the Replace Tool submenu.

TIP: When you replace one node with another, any settings that are identical between the two nodes are copied into the new node. For example, replacing a Transform node with a Merge will copy the existing center and angle values from the Transform to the Merge.

Deleting Nodes

To delete one or more selected nodes, press Delete (macOS) or Backspace (Windows), or right-click one or more selected nodes and choose Delete from the contextual menu. The node is removed from the Node Editor, and whichever nodes are connected to its primary input and output are now connected together. Nodes connected to other inputs (such as mask inputs) become disconnected.

Disconnected Nodes

It’s perfectly fine to have disconnected nodes, or even entire disconnected branches of a node tree, in the Node Editor alongside the rest of a composition. All disconnected nodes are simply ignored while being saved for possible future use. This can be useful when you’re saving nodes that you’ve customized but later decided you don’t need. It’s also useful for saving branches of trees that you’ve since exported to be self-contained media that’s re-imported to take the place of the original effect, but you want to save the original nodes just in case you need to redo your work.
Selecting and Deselecting Nodes

In order to work with nodes in the Node Editor in any way, or modify node parameters in the Inspector, you first need to learn to select the node or nodes you want to work with.

Selecting Nodes

Selecting nodes is one of the most fundamental things you can do to move nodes or target them for different operations. There are a variety of methods you can use.

Methods of selecting nodes:

- **To select a single node:** Click any node in the Node Editor.
- **To select multiple nodes one at a time:** Command-click each node you want to select.
- **To select a whole region of nodes:** Drag a bounding box around all nodes you want to select.
- **To select all upstream or downstream nodes:** Right-click a node and choose Select > Upstream Nodes/Downstream Nodes from the contextual menu.
- **To select all nodes in the Node Editor:** Press Command-A.
- **To select a node from the Keyframe Editor:** Click any layer in the Keyframe Editor to select the corresponding node in the Node Editor.

The Active Node

When you select a single node using any of the methods described above, the selected node is known as the active node, and is highlighted orange to indicate that its parameters are currently editable in the Inspector (if the Inspector is open). This also indicates that node will be targeted for specific operations (such as inserting new nodes).

While multiple nodes can be selected, only one node will be the active node. To indicate the difference, the active node remains highlighted with orange, while all other selected nodes are highlighted with white. Unselected nodes have simple black outlines.

The active node is highlighted orange, while other selected nodes are highlighted white.

**To set the active node when there are multiple selected nodes:**

- Option-click one of the selected nodes in the Node Editor to make that one the active node.
- Open the Inspector (if necessary), and click a node’s header bar to make it the active node.

Deselecting Nodes

Deselecting nodes, when necessary, works pretty much as you would expect.
Methods of deselecting nodes:
- Click once in the background of the Node Editor to deselect all nodes.
- Press Command-Shift-A to deselect all nodes.
- Command-click to deselect multiple nodes one at a time.
- Command-drag a bounding box to deselect a group of selected nodes at one time.

Loading Nodes into Viewers

Once you’ve started building a composition, the next thing you need to learn is how to view specific nodes that you want to work on. This is important because the combination of which node is being viewed and which node is currently selected (these aren’t always the same node) often determines which onscreen controls are available and how they appear.

In the following example, you’re set up to rotoscope an image using a Polygon node that’s attached to the garbage mask input of a MatteControl node which is inserting the mask as an alpha channel.

As seen in the screenshot above, you’ll want to load the upstream MediaIn or Loader node into a viewer while the Polygon node is selected for editing in order to see the full image you’re rotoscoping while keeping the Polygon node’s spline visible.
Viewed Nodes When You First Open Fusion

When you first open the Fusion page in DaVinci Resolve, the output of the current empty composition (the MediaOut1 node) is usually showing in viewer 2. If you’re in Dual-viewer mode, viewer 1 remains empty until you assign a node to one of them.

When you first open Fusion Studio with an empty comp, both viewers remain empty even after reading in media using a Loader node. The viewers only display content when you assign a node to one of them.

There are several different ways to display a node in a viewer. Which ones you use depends on how you like to work.

Node View Indicators

The View indicators are displayed under each node, and serve two purposes. First, they’re a clickable interface for displaying a node’s output in one of the viewers. Second, they’re an indication of which nodes in the Node Editor are being viewed. By default, there are two round indicators, representing the two viewers. The left and right indicators correspond to the left and right viewers, regardless of whether both viewers are visible or just one.

To load a node into a viewer using the Node View indicators:

- Clicking an indicator turns it white to show that node is currently loaded in the corresponding viewer. Clicking it again turns the indicator black and removes it from the viewer. Nodes only display View indicators if they’re currently being viewed. If you want to view indicators, hovering the pointer over the node makes the indicators visible and available for clicking.

- You can also use keyboard shortcuts to toggle each View indicator. The default two viewers are assigned numeric keyboard shortcuts 1 and 2. Pressing the corresponding number once displays the selected node in the appropriate display view, while pressing it again clears that display.

For complex compositions, you may need to open additional viewers. For example, one viewer may be used to display the end result of the final comp, while another viewer displays the source, a third viewer displays a mask, and a fourth viewer might be a broadcast monitor connected via a Blackmagic DeckLink card or other display hardware. When you have more than two viewers, additional View indicators are added and each one is assigned a consecutive number between 3 and 9.

The more viewers you add, the more you may need help remembering which viewer is represented by which View indicator. Positioning the pointer over the View indicator in question will display a tooltip with the name of the viewer it represents.

Drag and Drop Nodes into a Viewer

If the View indicators are too small of a target for you to click on reliably and you are not keyboard oriented, another way to load a node into a viewer is to drag and drop it onto the viewer you want to load it into. This offers a quick explicit way to assign a node to a viewer, especially for pen and tablet users. Please note that as you drag, the node will appear to move at first, but it’ll snap back into its original location once the pointer leaves the Node Editor.
Using the Contextual Menu

You can also right-click a node, and then choose View On > Left or Right to display the node on the appropriate viewer.

Clearing Viewers

Whenever you load a node into a viewer, you prompt that node, all upstream nodes, and other related nodes to be rendered. If you load nodes into both viewers, this is doubly true. If you want to prevent your computer from processing views that aren’t currently necessary, you can clear each viewer.

Methods of clearing viewers:

– Press 1 or 2 to empty the left or right viewers if they’re filled.
– Press ` (the Accent key) to empty both viewers.

Create/Play Preview

You can right-click a node, and choose an option from the Create/Preview Play On submenu of the contextual menu to render and play a preview of any node’s output on one of the available viewers. The Render Settings dialog is displayed, and after accepting the settings, the tool will be rendered and the resulting frames stored in RAM for fast playback on that view.

TIP: Hold the Shift key when selecting the viewer from the menu to bypass the Render dialog and to start creating the preview immediately using the default settings or the last settings used to create a preview.

Connecting and Disconnecting Nodes

Once you’ve started to add nodes to your composition, you need to connect them to perform their intended operations.

Node Basics

Each node displays small colored knots around the edges. One or more arrows represent inputs, and the square represent the tool’s processed output, of which there is always only one. Outputs are white if they’re connected properly, gray if they’re disconnected, or red to let you know that something’s wrong and the node cannot process properly.

A Blur node with a Foreground Input, Mask Input, and Output.

Each node takes as its input the output of the node before it. By connecting a MediaIn node’s output to a Blur node, you move image data from the MediaIn node to the Blur node, which does something to process the image before the Blur node’s output is in turn passed to the next node in the tree.
How to Connect Nodes

To manually connect one node to another, click on one node’s output and drag a connection line out to drop on another node’s input. The order in which you drag node connections is not important; you can just as easily drag a connection from one node’s input to another node’s output and get the same results.

Dropping Connections on Top of Nodes

To make your life a bit easier, you can also drag a connection line and drop it directly on top of the tile of a node to automatically connect to the default input of that node, which is usually labeled “background” or “input.” In the following example, a connection is dragged from the output of a MediaIn node and dropped onto the tile of a Blur1 node, and the background input is connected first.

If you drop a connection on top of a node that already has the background input connected, then the second most important connection will be attached, which for multi-input nodes is the foreground input, and for other single-use nodes may be the Effects Mask input.
Before (top), and after (bottom) dragging a connection line and dropping it on top of a node that has the background input already connected.

Some multi-input nodes are capable of adding inputs to accommodate many connections, such as the Merge3D node. These nodes simply add another input whenever you drop a connection onto them.

After dragging a connection line and dropping it on top of a Merge3D node.

Attaching Connections to Specific Inputs

If you want to make sure you don’t attach a connection to the default input of a node, then you need to drop it right on top of the specific node input you want to attach it to. If you can see the input’s label in the tooltip bar, then you know you’re correctly positioned to make a good connection.

However, there’s an alternate method of connecting nodes together in instances where there are several inputs to choose from and you want to make sure you’re choosing the correct one. Hold down the Option key while dragging a connection from one node’s output and dropping it onto the body of another node. This opens a pop-up menu from which you can choose the specific input you want to connect to, by name. Please note that this menu only appears after you’ve dropped the connection on the node and released your pointing device’s button.
Option-dragging a node connection to drop onto another node exposes a node input menu.

Automatically and Manually Attaching Mask Nodes
Mask nodes, such as the Polygon, B-Spline, Ellipse, or Rectangle, have a different automatic behavior when you connect them to other nodes. If you drag a connection from a Mask node onto the body of another node, it will automatically connect itself to the default mask input, which is usually the effect mask input. The assumption is that you’re using the mask to limit the node’s effect somehow. However, this isn’t always the case, so you’ll need to be careful of this behavior to make sure you’re attaching your mask to the input that will actually create the effect you need.

Before (left) and after (right) dragging a connection from a Mask node and dropping it on top of a MatteControl node.

Identifying Node Inputs
While you are still figuring out all the nodes and their inputs, hovering the pointer over any knot will display a node tip with the knot’s name.

**TIP:** Rather than remembering the different knot types, press the right mouse button, hold Option, and drag from the output of a node to the center of another tool. When you release the mouse, a tooltip will appear allowing you to select the knot you want to connect to.
Node Order Matters

The order in which nodes are attached defines the order in which each image-processing operation is applied to the image.

In the following example, a MediaIn node adds a clip to the composition, while a Defocus node blurs the image, and then a TV node adds scanlines and vertical distortion. Those effect nodes are then connected to the MediaOut node in the Fusion page in DaVinci Resolve or a Saver node in Fusion Studio.

Adding a Defocus effect first, then the TV node second.

As you can see above, connecting the Defocus node first, followed by the TV node, means that while the initial image is softened, the TV effect is sharp. However, if you reverse the order of these two nodes, then the TV effect distorts the image, but the Defocus node now blurs the overall result, so that the TV effect is just as soft as the image it’s applied to. The explicit order of operations you apply makes a big difference.
Adding a TV effect first, and a Defocus second.

As you can see, the node tree that comprises each composition is a schematic of operations with tremendous flexibility. Additionally, the node tree structure facilitates compositing by giving you the ability to direct each node’s output into separate branches, which can be independently processed and later recombined in many different ways, to create increasingly complex composites while eliminating the need to precompose, nest, or otherwise compound layers together, which would impair the legibility of your composition.

In the following example, several graphics layers are individually transformed and combined with a series of Merge nodes. The result of the last Merge node is then transformed, allowing you to move the entire collection of previous layers around at once. Because each of these operations is clearly represented via the node tree, it’s easy to see everything that’s happening, and why.

The output of five Text nodes being combined using Merge nodes is modified by a single Transform node.
Upstream and Downstream Nodes

Since nodes can be positioned anywhere in the Node Editor, and added in any direction, nodes are referred to as being upstream and downstream of one another. Once you select a node, all other nodes that directly or indirectly connect to its input are considered to be upstream. Any other nodes that are directly or indirectly connected to the output are said to be downstream.

This is an important distinction to make because, unlike layer-based systems, the visual positioning of nodes in your node tree has no bearing on the order of operations in that composition. The only thing that matters is whether nodes are upstream or downstream of each other.

Tools upstream (left) and downstream (right) of the Merge node.

TIP: To help you stay organized, there are Select > Upstream/Downstream commands in the Node Editor contextual menu for selecting all upstream or downstream nodes to move them, group them, or perform other organizational tasks.

Disconnecting and Reconnecting Nodes

Node trees are a continuous work in progress, requiring constant revision and rearrangement as you discover new details that need to be finessed, or things that you can do better once the overall composition has taken shape. To facilitate quick changes, each connection between two nodes is divided into two halves: the output half (connected to the upstream node’s output) and the input half (connected to the downstream node’s input). This can only be seen when you hover the pointer over a connection. The half your pointer is over is highlighted in blue.

The two halves of a connection line that are revealed when you hover your pointer over it.

By clicking and/or dragging these two halves, it’s possible to quickly disconnect, reconnect, and overwrite node connections, which is essential to rearranging your node tree quickly and efficiently.

To disconnect two nodes, do one of the following:

- Click once on the input half of the connection between two nodes.
- Click on the input arrow to which a connection is attached, then drag to pull the connection away from the tool and drop it anywhere in an empty area of the Node Editor.

To overwrite a current connection:

- Drag the output or input half of a connection, and drop it directly onto another node’s input or output. This simultaneously disconnects the previous connection and connects the one you’re dragging.
To reconnect a connection from one node to another:

- Drag the output or input half of a connection to disconnect it from one node, and drop the connection directly on another node’s input or output.

### Tracing Connections Through the Node Tree

Positioning the pointer over a node causes the connections attached to that node to become highlighted, which makes it easier to see which nodes it’s attached to. Additionally, highlighted connections display the color of the input they’re connected to, which makes it easy to see if they’re connected to a foreground, a background, or a particular kind of mask.

![Image of node connections](image.png)

Hovering the pointer over a node highlights the color of all connections, telling you what kinds of inputs are connected.

Additionally, positioning the pointer over a connection causes a tooltip to appear that displays the output and input that connection is attached to.

![Image of node connection tooltip](image.png)

Hovering the pointer over a node highlights the connection between it and other nodes.

### Branching

A node’s input can only have one connection attached to it. However, a tool’s output can be connected to inputs on as many nodes as you require. Splitting a node’s output to inputs on multiple nodes is called branching. There are innumerable reasons why you might want to branch a node’s output. A simple example is to process an image in several different ways before recombining these results later on in the node tree.

![Image of node branching](image.png)

A MediaIn node branched to two node operations and then recombined using a Merge node.
Alternatively, it lets you use one image in several different ways—for example, feeding the RGB to one branch for keying and compositing, while feeding the A channel to the Effects Mask input of another node to limit its effect, or feeding RGB to a tracker to extract motion information.

A MediaIn node branched to two different kinds of inputs, used separately.

## Connecting Merge Nodes

The Merge node is the primary tool available for compositing images together. Each Merge node is capable of combining two inputs to create a third, using standard compositing methods and composite modes. For more extensive information about the Merge node, see Chapter 105 “IO Nodes” in the DaVinci Resolve Reference Manual or Chapter 44 in the Fusion Reference Manual. For this chapter, all you need to know is that if you attach a background image to the Background input (such as a landscape), and a foreground image with an alpha channel to the Foreground input (such as a graphic with an alpha channel), the Merge node will combine them into a single image for further compositing.

Two MediaIn nodes and a DeltaKeyer node attached to a Merge node, creating a composite.

Each Merge node has three inputs:

- **Background (orange):** The default input. Whichever image is connected to this input defines the output resolution of the Merge node.
- **Foreground (green):** The secondary input, meant for whichever image you want to be "on top."
- **Effect Mask (blue):** An optional input you can use to attach a mask or matte with which to limit the effect of the Merge node.

It’s important to make sure you’re attaching the correct nodes to the correct inputs to ensure you’re getting the result you want, and it’s important to keep these inputs in mind when you connect to a Merge node. Of course, you can always drag a connection to a specific input to make sure you’re connecting things the way you need. However, if you’re in a hurry and you simply drag connections right on top of a Merge node:

- The first connection will be made to the background input.
- The second connection will be made to the foreground input.
- The third connection will be made to the effect mask input.
Automatically Creating a Merge Node When Adding Nodes

There’s a nice shortcut for connecting Merge nodes if you want to connect the incoming clip immediately to your node tree as the top layer of a composite, and that’s to drag a clip from an Operating System window or a Generator from the Effects Library right on top of any connection line. When you drop the resulting node, this automatically creates a Merge node, the background input of which is connected to the next node to the left of the connection you dropped the clip onto, and the foreground input of which is connected to the new node that represents the clip or Generator you’ve just added.

Additionally, if you drag two or more nodes from an OS window into the Node Editor at the same time, Merge nodes will be automatically created to connect them all, making this a fast way to initially build a composite.

Automatically Creating a Merge Node by Connecting Two Outputs

Here’s an endlessly useful shortcut for when you have a disconnected node that you want to composite over another node. Drag a connection from the output of the node you want to be the foreground layer, and drop it on top of the output of the node you want to be the background layer, and a Merge node will be automatically created to build that composite.
Connection Options and Routers

By default, the Node Editor uses linear connections that are drawn straight between any two connected nodes. While efficient, this sometimes causes connection lines to overlap nodes, which some people feel interferes with the view of the Node Editor.

If you like, you can change how connections are drawn by enabling orthogonal connections, which automatically draws lines with right angles to avoid having connections overlap nodes.

Functionally, there’s no difference to your composition; this only affects how your node tree appears.

To change how connections are drawn in the Node Editor:
– Right-click the Node Editor background and choose one of the following from the contextual menu.
  – Options > Direct Pipes
  – Options > Orthogonal Pipes
Using Routers to Reshape and Branch Connections

If you want to force a particular connection to be drawn at an angle to keep your node tree tidy, you can add a router to either linear or orthogonal connections to force an angle so it will be drawn however you like.

Routers are tiny nodes with a single input and an output, but with no parameters except for a comments field (available in the Inspector), which you can use to add notes about what’s happening in that part of the composition.

Even more usefully, you can branch a router’s output to multiple nodes, which makes routers even more useful for keeping node trees neat in situations where you want to branch the output of a node in one part of your node tree to other nodes that are all the way on the opposite end of that same node tree.
Methods of using routers:

– **To add a router to a connection**: Option-click anywhere on a connection.

– **To move a router**: Drag the router to a new location, and the connection will reshape itself as necessary.

– **To branch a router’s output**: Drag a connection from the router output to the input of another node. You can branch a router’s output as many times as you need to.

– **To remove a router**: Select any router and press the Delete key, or right-click a router and choose Delete from the contextual menu.

### Swapping Node Inputs

For multiple-input nodes such as the Merge, Merge 3D, and Dissolve nodes, there’s a quick method of swapping the Primary and Secondary inputs, such as the foreground and background inputs of a Merge tool, when you find you’ve accidentally connected them in the wrong order. If a node has more than two of its inputs connected, only the foreground and background inputs will be swapped.

**To swap the primary inputs of a multi-input node, do one of the following:**

– Select a node and press Command-T to reverse its inputs.

– Right-click a node and choose Swap Inputs from the contextual menu.

Before swapping node inputs (left), and after swapping node inputs (right), the connections don’t move but the colors change.

Inputs can move freely around the node, so swapping two inputs doesn’t move the connection lines; instead, the inputs change color to indicate you’ve reversed the background (orange) and foreground (green) connections.

### Extracting and Inserting Nodes

When building a composition, you’ll often find that you need to rearrange nodes that you’ve already added, in order to connect them in different ways to obtain a better result. Happily, this is easy to do by extracting one or more nodes from one part of a node tree and inserting them at another part of the node tree.

To extract one or more nodes from their position in the node tree:

– **To extract a single node**: Hold down the Shift key, drag a node from the node tree up or down to disconnect it, and then drop the node before releasing the Shift key. That node is now detached, and the output of the next upstream node is automatically connected to the input of the next downstream node to fill the gap in the node tree.

– **To extract multiple nodes**: Select the nodes you want to extract, hold down the Shift key, drag one of the selected nodes up or down to disconnect them, and then drop the node before releasing the Shift key. Those nodes are now detached (although they remain connected to one another), and the output of the next upstream node is automatically connected to the input of the next downstream node to fill the gap in the node tree.
After you’ve extracted a node, you can re-insert it into another connection somewhere else. You can only insert one node at a time.

**To insert a disconnected node in the Node Editor between two compatible nodes:**

1. Hold down the Shift key and drag a disconnected node directly over a connection between two other nodes.
2. Once the connection highlights, drop the node, and then release the Shift key. That node is now attached to the nodes coming before and after it.

**TIP:** If you hold down the Shift key, you can extract a node and re-insert it somewhere else with a single drag.

### Cut, Copy, and Paste Nodes

The standard operations of cut, copy, and paste are also available in the Node Editor. You can use them to temporarily remove nodes from the Node Editor, create duplicate nodes, or even copy the settings from one node and paste those settings into another node with compatible settings.

#### Cut, Copy, and Paste in the Node Editor

The standard commands all work, but with some special features specific to the Node Editor.

**To copy one or more selected nodes, do one of the following:**

- Right-click a node and choose Copy from the contextual menu.
- Choose Edit > Copy from the Edit menu (Command-C).

**To cut one or more selected nodes, do one of the following:**

- Right-click over the node and choose Cut from the contextual menu.
- Choose Edit > Cut from the Edit menu (Command-X).
When you paste into the Node Editor, you create a copy of the last node or nodes you’ve cut or copied. When pasting, there are a few different things you can do to control where pasted nodes appear.

To paste one or more selected nodes, do one of the following:

– To paste nodes to be inserted after another node: Select the node in the node tree you want to insert the pasted node(s) to, and choose Edit > Paste (Command-V).

– To paste nodes to be disconnected from the rest of the node tree: Deselect all nodes, and then choose Edit > Paste (Command-V), or right-click anywhere in the Node Editor and choose Paste from the contextual menu.

– To paste disconnected nodes in a specific area of the Node Editor: Deselect all nodes, and then click the place in the Node Editor where you want pasted node(s) to appear, and choose Edit > Paste (Command-V), or right-click anywhere in the Node Editor and choose Paste from the contextual menu.

– To paste a node to replace an existing node in the Node Editor: Right-click a node in the Node Editor that you want to replace, choose Paste from the contextual menu, and when a dialog appears asking if you want to replace that node, click OK. This only works when you use the contextual menu command.

TIP: When you paste a MediaIn, Loader, or Generator node so it will be inserted after a selected node in the node tree, a Merge tool is automatically created and used to composite the pasted node by connecting it to the foreground input. While this can save you a few steps, some artists may prefer to perform these sorts of merges manually, so this can be changed using the Default Preferences panel in the Global preferences.

Pasting Node Settings

Instead of pasting a node, you can choose to paste just the parameter settings that you copied from another node. This can be useful if you’ve carefully set or animated parameters in one node that you want to also use in another node.

Note that you can paste settings between two nodes of the same type, or between two entirely different kinds of nodes that happen to have one or more of the same parameters in the Inspector. When copying settings from one type of node to another, only the settings that match between two nodes will be copied. A common example is to copy an animated Center parameter from a Transform node to the Center parameter of a Mask node.

To Paste settings from one node to another:

1. Select a node that has settings you want to copy, and choose Copy from the Edit menu (Command-C).
2. Right-click a node you want to paste those settings to, and choose Paste Settings from the contextual menu.

Copying and Pasting Nodes to and from Any Text Editor

The format of nodes in the Node Editor is not binary, but is in fact a simple text format. The implications of that may not be obvious, but one example benefit is clear when you start dealing with nodes.

One or more nodes can be copied from the Node Editor and pasted directly into a text editor or email. This pastes the selection in text format, just as it’s saved internally in Fusion. For example, if you copy the following set of three nodes:
A set of three nodes being copied.

And you then paste into a new text editing document, you get the following:

![Image of pasted nodes]

The same three nodes pasted into a text editor.

At this point, you have the option of editing the text (if you know what you’re doing), emailing it to colleagues, or storing it in a digital notepad of some sort for future use. To use this script in Fusion again, you need only copy it and paste it back into the Node Editor.

**TIP:** This is a very easy way to pass specific node settings back and forth between artists who may not be in the same room, city, or country.

### Instancing Nodes

Normally, when you use copy and paste to create a duplicate of a node, the new node is completely independent from the original node, so that changes made to one aren’t rippled to the other. However, there are times when two nodes must have identical settings at all times. For example, when you’re making identical color corrections to two or more images, you don’t want to constantly have to adjust one color correction node and then manually adjust the other to match. It’s a hassle, and you risk forgetting to keep them in sync if you’re working in a hurry.

While there are ways to publish controls in one node and connect them to matching controls in another node, this becomes prohibitively complex and time consuming for nodes in which you’re making adjustments to several controls. In these cases, creating “instanced” nodes is a real time-saver, as well as an obvious visual cue in your node tree as to what’s going on.
Using Instanced Nodes

Instanced nodes are nodes that have been created using the Paste Instance command, and which share settings with the original node so that a change made to one instanced node is also automatically applied to all other instances of that node (as well as the original node you copied).

To create an instance, do the following:

1. Select a node you want to instance, and copy it (Command-C).
2. Do one of the following:
   - **To create a disconnected instance of a node:** Right-click in the background of the Node Editor, and choose Paste Instance from the contextual menu (Command-Shift-V).
   - **To insert an instanced node between two other nodes:** Select a node that’s upstream of where you want to insert the instanced node, and press Command-Shift-V. Alternatively, you can right-click directly on a connection line, and choose Paste Instance from the contextual menu.

However you paste an instance, the name of that instanced node takes the form “Instance_NameOfNode.” If you paste multiple instances, each instance is numbered “Instance_NameOfNode_01.”

A green link line shows an instanced Blur node’s relationship to the original Blur node it was copied from.

When a node tree contains instanced nodes, a green line shows the link between the original node and its instances. You have the option to hide these green link lines to reduce visual clutter in the Node Editor.

**To toggle the visibility of green instance link lines in the Node Editor:**

1. Right-click anywhere in the background of the Node Editor.
2. Choose Options > Show Instance Links from the contextual menu.

If you’ve been using an instance of a node and you later discover you need to use it to apply separate adjustments, you can “de-instance” the node.
To de-instance a node, making it independent:

1. Right-click an instanced node.
2. Choose Deinstance from the contextual menu. That node is now independent from the original node. Once you de-instance a node, you cannot re-instance it, but you can undo the operation.

**NOTE:** If you’ve de-instanced a node and you cannot undo the operation because you’ve restarted DaVinci Resolve, you can only recreate an instance by copying the original and pasting an instance again.

De-Instancing and Re-Instancing Specific Parameters

By default, every parameter in an instanced node is linked to the original node, so that any change you make is rippled across. However, from time to time you’ll find the need to independently adjust just one or two parameters while keeping the rest of that node’s parameters linked. For this reason, instead of de-instancing the entire tool, you can de-instance individual parameters.

**To de-instance a single parameter:**

– Right-click on a parameter’s name or value in the Inspector, and choose Deinstance from the contextual menu.

If you’ve only de-instanced individual parameters, you can re-instance those parameters later on if you change your mind.

**To re-instance a single parameter:**

– Right-click on a parameter’s name or value in the Inspector, and choose Reinstance from the contextual menu. That parameter immediately inherits the setting of the original node.

Keeping Node Trees Organized

Similar to working with files on your desktop, even the simplest of composites require you to do some amount of organization. In this section we’ll look at some basic node operations, some of which you may already be familiar with just from using your computer’s operating system or other applications.

Moving Nodes

Selecting one or more nodes and dragging them moves them to a new location, which is one of the simplest ways of organizing a node tree, by grouping nodes spatially according to the role they play in the overall composition.

Keep in mind that the location of nodes in the Node Editor is purely aesthetic, and does nothing to impact the output of a composition. Node tree organization is purely for your own peace of mind, as well as that of your collaborators.

**TIP:** Once you’ve arranged the nodes in a composition in some rational way, you can use the Sticky Note and Underlay tools to add information about what’s going on and to visually associate collections of nodes more definitively. These tools are covered later in this section.
Snapping Nodes to the Grid

By default, you can position nodes freely wherever you want them to be. However, keeping nodes and connection lines straight and aligned can make them easier to read. To help keep them aligned, you can have nodes you’re dragging automatically snap to the grid.

To have nodes snap to the grid as they’re dragged:

– Right-click over an empty area of the Node Editor, and choose Arrange Tools > To Grid from the contextual menu. All nodes you drag now snap to the nearest grid coordinate.

– Right-click over an empty area of the Node Editor, and choose Arrange Tools > To Connected from the contextual menu. All nodes you drag now snap to the horizontal or vertical position of the nodes they’re attached to.

**TIP:** You can set “Arrange to Grid” or “Arrange to Connected” as the default for new compositions by choosing Fusion > Fusion Settings in DaVinci Resolve or File > Preferences in Fusion Studio, and turning the Fusion > Node Editor > Arrange To Grid or Arrange to Connected checkboxes on.

Commands to “Clean Up” a Node Tree

The grid in the background of the Node Editor can be used to align nodes, either by eye or automatically.

**To “clean up” an unruly node tree:**

– Right-click in an empty section of the Node Editor, and choose Line Up All Tools to Grid from the contextual menu. All nodes in the Node Editor will move to align and center themselves along the nearest grid lines.

**To “clean up” only one or more selected nodes:**

– Right-click one of the selected nodes and choose Line Up to Grid from the contextual menu. All selected nodes will move to align and center themselves along the nearest grid lines, while all unselected nodes will be left as they are.

Renaming Nodes

Each node that’s created is automatically assigned a name (based on its function) and a number (based on how many of that type of node have been created already). For example, the first Blur node added to a composition will be called Blur1, the second will be Blur2, and so on. Although initially helpful, larger compositions may benefit from important nodes having more descriptive names to make it easier to identify what they’re actually doing, or to make it easier to reference those nodes in expressions.

**To rename a node:**

1. Do one of the following:
   – Right-click a node and choose Rename from the contextual menu.
   – Select a node and press F2.

2. When the Rename dialog appears, type a new name, and then click OK or press Return.

**NOTE:** If multiple nodes are selected, multiple dialogs will appear asking for a name for each tool.
Since Fusion can be scripted and use expressions, the names of nodes must adhere to a scriptable syntax. Only use alphanumeric characters (no special characters), and do not use any spaces. Also, you cannot start a node name with a number. If you accidentally create a name that doesn’t exactly follow the guidelines, spaces and invalid characters will be automatically deleted.

**Changing Node Colors**

You can change the color of any node by selecting it, opening the Inspector, and choosing a new color from the Node Color pop-up in the Inspector header for that node. Alternatively, you can right-click a node and choose a color from the Set Color submenu.

To return a node to its regular color, right-click it and choose Set Color > Clear Color from the contextual menu, or open the Node Color pop-up for a node in the Inspector, and choose Clear Color.

**Using Sticky Notes**

A good way to add notes about different parts of a composition, client feedback about various details, and other information you want to keep track of, is to add Sticky Notes to the Node Editor.

![A Sticky Note in the Node Editor.](image)

Sticky Notes are yellow boxes in which you can type whatever text you want. They can be resized, moved, and collapsed when they’re not being edited, but once created they remain attached to the background of the Node Editor where you placed them until you either move them or delete them.

**Methods of working with Sticky Notes:**

- **To create a Sticky Note:** Click somewhere in the Node Editor where you want a Sticky Note to appear. Then, press Shift-Spacebar, type sticky, and press the Return key when the Sticky Note appears in the Select Tool window. Alternatively, you can open the Effects Library, open the Tools > Node Editor category, and click or drag the Sticky Notes node to create a new one.
- **To open a Sticky Note to full size:** Double-click a minimized Sticky Note and it expands to a larger, resizable yellow box.
- **To edit a Sticky Note:** If necessary, double-click a Sticky Note to open it to full size, and then click once in the body of the note to place a text cursor. You can edit text within the Sticky Note just like any other text editor.
- **To rename a Sticky Note:** Right-click a Sticky Note, choose Rename, type a new name into the Rename dialog, and click OK. Alternatively, you can select a Sticky Note, press F2 to open the Rename dialog, and press Return to close it when you’re done.
- **To resize a Sticky Note:** Double-click a Sticky Note to open it to full size, and then drag any of the edges or corners to make it larger or smaller.
- **To minimize a Sticky Note:** Click the close box at the upper left-hand corner of the Sticky Note, and it collapses to a small tile.
- **To delete a Sticky Note:** Right-click any Sticky Note and choose Delete from the contextual menu or select the Sticky note in the Node Editor and press the Delete key.
Using Underlay Boxes

Underlay Boxes are a good way of associating a collection of nodes that work together to perform a specific task in your composition. They’re simply colored rectangles that you can put nodes inside of. Once you place nodes inside an Underlay, you can move the Underlay, and all the nodes within move along with it.

![An Underlay in the Node Editor.](image)

Underlay Boxes can be named to identify the purpose of that collection of nodes, and they can be colored to be distinct from other Underlay Boxes or to adhere to some sort of color code for your compositions.

Methods of working with Underlay Boxes:

- **To create an Underlay Box:** Click somewhere in the Node Editor where you want the Underlay Box to appear. Then, press Shift-Spacebar, type under, and press the Return key when the Underlay Box appears in the Select Tool window. Alternatively, you can open the Effects Library, open the Tools > Node Editor category, and click or drag the Underlay Box node to create a new one.

- **To create an Underlay Box around specific nodes:** Select the nodes in the Node Editor that you want surrounded by an Underlay Box. Then, press Shift-Spacebar, type under, and press the Return key when the Underlay Box appears in the Select Tool window. Alternatively, you can open the Effects Library, open the Tools > Node Editor category, and click the Underlay Box node to have it added and sized to encompass all the selected nodes.

- **To resize an Underlay Box:** Drag any of the edges or corners to make it larger or smaller.

- **To rename an Underlay Box:** Option-click the Underlay Box to select just the box and not the contents, and then right-click it and choose Rename (or press F2). Type a new name into the Rename dialog and click OK or press Return.

- **To change the color of an Underlay Box:** Option-click the Underlay Box to select just the box and not the contents, and then right-click it and choose a color from the Set Color submenu.

- **To put nodes inside of an Underlay Box:** Select the nodes you want to place inside an Underlay Box, and then drag them to fit inside. The Underlay Box must be big enough to fit all the nodes. Alternatively, you can place an Underlay Box near a collection of nodes you want to put inside it, and then resize the Underlay Box to encompass all those nodes.

- **To move an Underlay Box and all its nodes:** Once nodes have been placed inside an Underlay Box and have been deselected, you can move the entire collection of nodes together by dragging the Underlay Box by its title bar.
– **To remove nodes from an Underlay Box**: There are two ways you can remove nodes from an Underlay Box.

  – With both the Underlay Box and nodes deselected, drag a bounding box or Command-click to select all nodes in the box you want to remove, and drag them out.
  
  – Resize the Underlay Box so that it’s smaller than the collection of nodes it originally encompassed. Once an Underlay Box is so small that even the last node sticks out beyond its edge, those nodes are automatically removed from the Underlay Box, and you can move or delete the Underlay Box without moving those nodes.

– **To delete an Underlay Box and all nodes within**: Select an Underlay Box and press the Delete key to delete both the Underlay Box and all nodes found inside it. If you don’t also want to delete the nodes, first drag the nodes out of the box.

– **To delete an Underlay Box but keep all nodes within**: Option-click the Underlay Box to select it and not the nodes, and then press the Delete key. The nodes within remain where they were.

### Node Thumbnails

Once a source or an effect has been added to the Node Editor, it’s represented by a node. By default, nodes are rectangular and thin, making it easier to fit reasonably complicated grades within a relatively small area. However, if you like, you can also display node thumbnails.

A node in the Node Editor shown without and with a thumbnail.

Nodes can be displayed as a small rectangle or as a larger square. The rectangular form displays the node’s name in the center, while the square form shows either the tool’s icon or a thumbnail of the image it is outputting.

**TIP:** Even if you’re not displaying node thumbnails, you can quickly obtain detailed information about a node and the data it’s processing by hovering your pointer over it in the Node Editor and viewing the tooltip bar below.

### Choosing Which Nodes Show Thumbnails

If you want to use node thumbnails to help visually identify media and operations in your node trees, there are a variety options for which nodes should display thumbnails in the contextual menu that appears when you right-click anywhere in the background of the Node Editor.
Force All Tile Pictures
This option shows thumbnails for every single node in the Node Editor. This can make simple node
trees easier to read, but it’ll make all node trees take up considerably more room.

NOTE: If Show Thumbnails is enabled, nodes may not update until the playhead is moved in
the Time Ruler.

Force Active Tile Pictures
You may also choose to only show thumbnails for nodes that are currently selected, which can make it
easier to see which node you’re working on. When nodes become deselected, the thumbnails will be
hidden again.

Force Source Tile Pictures
This enables thumbnails for all MediaIn and Loader nodes in the Node Editor, as well as all generators,
and is a great way to be able to quickly see where all the clips are in a composition.

Force Mask Tile Pictures
This enables thumbnails for all Mask nodes in a composition, which can make them easier to
distinguish when you’re building complex shapes made from multiple Mask nodes.

Manually Showing Tile Pictures and Node Options
You also have the option of manually choosing which nodes you’d like to show thumbnails.
For example, there may be certain key points of the node tree where you’d like to see a small visual
representation of what’s happening in the composition.

To toggle thumbnails for one or more specific nodes:
1 Select one or more nodes in the Node Editor.
2 Right-click one of the selected nodes, and choose one of the following from the contextual menu:
   – Show > Show Tile Pictures
   – Show > Show Modes/Options

When you’ve manually enabled thumbnails for different nodes, they’ll remain visible whether or not
those nodes are selected.

Switching Thumbnails between Images and Icons
Whenever you enable node thumbnails, you have the choice of having these thumbnails either display
an image of the state of the image at that node, or you can instead choose to display the icon for that
particular node. The setting for this affects all nodes at once.

To display icons instead of thumbnails:
   – Right-click anywhere in the background of the Node Editor and deselect Show Thumbnails in the
     contextual menu.
Sometimes Nodes Only Show Icons

As you add more and more nodes to a composition, you’ll notice that some nodes never display an image in their thumbnail. In these cases, the default icon for that node is displayed instead of an image.

Most nodes in the Particle and 3D categories fall into this group. The exceptions are the pRender node and the Render 3D node. These two nodes are capable of displaying a rendered thumbnail if you have the menu options set for Thumbnails to be displayed.

In other cases, whether nodes display images in their thumbnail is more situational. Some Transform nodes are able to concatenate their results with one another, passing the actual processing downstream to another node later in the node tree. In this case, upstream Transform nodes don’t actually process the image, so they don’t produce a thumbnail.

In other situations where the Loader is not reading in a clip or the clip is trimmed in the Keyframes Editor to be out of range, it can cause the node not to process the image, so it will not produce a rendered Thumbnail image. Also, nodes that have been set to Pass Through mode are disabled and do not display a rendered Thumbnail image.

Finding Nodes

Modern visual effects require detailed work that often results in compositions with hundreds of nodes. For such large node trees, finding things visually would have you panning around the Node Editor for a long, long time. Happily, you can quickly locate nodes in the Node Editor using the Find dialog.

Performing Simple Searches

To do simple searches using node names is easy.

To search for a node in the Node Editor:

1. Press Command-F, or right-click in an empty area of the Node Editor and choose Find from the contextual menu.
2. When the Find dialog appears, do the following:
   - Enter a search term in the Find field.
   - Choose search options, such as whether to match the whole phrase in the Find field, whether to match the case, whether to use a sequence number, or whether to use a regular expression in the Find field.
   - Choose what to search. Options include tool name, tool type name, or tool type ID.
To perform the find, do one of the following:

– Click Find Next to try to select a downstream node matching the criteria.
– Click Find Previous to try to select an upstream node matching the criteria.
– Click Find All to try to select all nodes in the Node Editor that match the criteria.

The Find window closes. If either the Find Next, Find Previous, or Find All operations are successful, the found node or nodes are selected. If not, a dialog appears letting you know that the string could not be found.

**TIP:** Finding all the nodes of a particular type can be very useful if you want, for example, to disable all Resize nodes. Find All will select all the nodes based on the search term, and you can temporarily disable them by pressing the shortcut for Bypass, Command-P.

### Using Regular Expressions

If you need to do more complicated searches, you can turn on the Regular Expression checkbox, which lets you enter some simple expressions with which to create more complex find operations. Some useful examples of regular expressions that are valuable include the use of Character Sets.

#### Character Sets

Any characters typed between two brackets [ ] will be searched for. Here are some examples of character set searches that work in Fusion.

- 

  **Finds:** Every node using a lower caps letter

  ```text
  [a-z]
  ```

- 

  **Finds:** Every lower caps letter from a to d, and will find nodes with a, b, c, or d

  ```text
  [a-d]
  ```

- 

  **Finds:** Every node with an upper case T or a lower case t

  ```text
  [Tt]
  ```

- 

  **Finds:** Every vowel

  ```text
  [aeiou]
  ```

- 

  **Finds:** Every numeral

  ```text
  [0-9]
  ```

- 

  **Finds:** Every numeral from five to seven, and will find nodes numbered with 5, 6, or 7

  ```text
  [5-7]
  ```
Custom Node Settings

When a node is added to the Node Editor, its parameters are set to the default values for that type of node. If you find yourself constantly readjusting the parameters of a node to a preferred starting point as soon as it’s added to the node tree, you can override the default node settings with your own custom settings.

To save new default settings for a particular type of node:

1. Create a new node.
2. Open the Inspector and customize that node’s settings to the new defaults you want it to have.
3. Right-click that node in the Node Editor, or right-click that node’s control header in the Inspector, and choose Settings > Save Default from the contextual menu.

**TIP:** You can also save six different settings for a node in the Node Editor using the Version buttons at the top of the Inspector. For more information, see Chapter 69, “Editing Parameters in the Inspector” in the DaVinci Resolve Reference Manual or Chapter 8 in the Fusion Reference Manual.

Managing Saved Settings

Custom node default settings are saved to a folder on your hard drive that’s based on the Path Map > Defaults preference in the Fusion Settings. This path is customizable for facilities where multiple compositing artists use a common set of facility defaults, stored somewhere commonly accessible. The default paths are:

- **For macOS systems, this path defaults to:** /UserName/Library/Application Support/Blackmagic Design/DaVinci Resolve/Fusion/Defaults.
- **For Windows systems, this path defaults to C:** \Users\<username>\AppData\Roaming\Blackmagic Design\DaVinci Resolve\Fusion\Defaults.
- **For Linux systems, this path defaults to:** ~/.fusion/BlackmagicDesign/DaVinci Resolve/Fusion/Defaults.

If you browse this directory, the settings for each node are saved using a name taking the form INTERNALNAME_PUBLICNAME.settings, where INTERNALNAME is the internal name of the Fusion tool, and PUBLICNAME is the name of the Node that’s derived from the internal Fusion tool. For example, the default setting for a Blur node would be called Blur_Blur.setting. This naming convention is partly to ensure that third-party plug-in nodes don’t overwrite the defaults for built-in Fusion nodes that happen to have the same name.

Resetting Defaults

Even if you’ve created new default settings for new nodes, you can always reset individual parameters to the original default setting. In addition, it’s easy to restore the original default settings for new nodes you create.

To reset a single parameter to the original default settings:

1. Create a new node.
2. Open the Inspector and customize a parameter to the new default value you want it to have.
3. Right-click that parameter in the Inspector, and choose Set to Default from the contextual menu.
To reset every parameter in a node to the original defaults, do one of the following:

- Right-click on the node and choose Settings > Reset Default.
- Right-click that node's control header in the Inspector, and choose Settings > Reset Default.
- Delete the .setting file from the Defaults folder.

**NOTE:** When you use the Settings > Reset Default command, the default .setting file is deleted. If you want to save a node's settings as alternate settings, you should use the Settings > Save As command.

**Saving and Loading Alternate Node Settings**

Once you change parameter values for a node using the Inspector, those values can also be saved as an alternate setting for that node, which can be reused at a later time.

**To save alternate settings for a node:**

1. Right-click on a tool, and then choose Settings > Save As from the contextual menu.
2. When the Save File dialog appears, enter a name for the Setting and save it to your hard drive. Unlike saved defaults, the .settings files can be saved anywhere on the file system. They do not need to be in the Default Settings folder.

**To load a saved setting for one or more nodes:**

1. Right-click a node and choose Settings > Load from the contextual menu.
2. Use the Open File dialog to select the settings you want to load into that node, and then click Open. Those settings are now applied to that node.

**Adding Saved Settings from the File System**

Saved settings in your File system can also be used to create new nodes by dragging the .setting file into the Node Editor from a standard file browser. Once dropped, that setting turns into a new node.

**TIP:** If you drop a setting directly onto a connection line, the new node will be inserted onto that connection.

**Node Modes Including Disable and Lock**

Right-clicking one or more nodes and opening the contextual menu reveals a series of commands in the Modes submenu, some with accompanying keyboard shortcuts, that let you set control visibility, disable, lock, update, and cache nodes.

- **Show Controls:** Sets whether that node reveals its parameters in the Inspector when it's selected and whether its onscreen controls appear in viewers. On by default.
- **Pass Through:** (Command-P) Identical to the toggle switch in the Inspector that turns nodes off and on. Disabled nodes are ignored as image data is passed from the next previous upstream node to the next downstream node. On by default.
- **Locked:** (Command-L) Identical to the lock button in the Inspector that prevents a node from being edited in the Inspector. Off by default.
– **Update:** (Command-U) On by default. While this option is enabled, all changes to the node will cause it to re-render. When Update is disabled, you can still change the node’s parameters, but those changes will not process or update the image until Update is re-enabled. While disabled, the last processed image for that node will be displayed as a freeze frame. One example of when this is useful is when you have a large or processor-intensive composition (such as a particularly intense particle system), and disabling this option temporarily will let you quickly make several quick parameter adjustments to different nodes without forcing you to wait for the node tree to re-render after every adjustment. Another example of when this is useful is when you want to quickly see the effect of animated downstream nodes while keeping upstream nodes that are too processor-intensive to play in real time from rendering additional frames.

– **Force Cache:** When enabled, this node’s output for the current frame has an extremely high cache priority, essentially forcing it to stay cached in memory. Off by default.

Toggling any one of these node modes displays a badge within that node indicating its state.

## Node Editor Options

Right-clicking in an empty area of the Node Editor will bring up the contextual menu and the Options submenu. The Options submenu contains several choices that can be used to customize how the Node Editor looks and behaves.

– **Pipes Always Visible:** Enabling this option causes a connection to cross over a node instead of beneath it, sometimes making it easier to follow the connection’s path.

– **Show Hidden Connections:** When enabled, the Inspector option to Hide Incoming Connections in every node is overridden and all connections are displayed in the Node Editor.

– **Aspect Correct Tile Pictures:** Aspect Correct Tile Pictures forces the display of thumbnails to be aspect corrected, which is slower but visually more accurate. This option is enabled by default.

– **Full Tile Render Indicators:** Enabling this option causes the thumbnail to flash green when rendering, which makes it easier to identify which node is processing in a large, complex node tree.

– **Show Grid:** This option can be used to enable or disable the Node Editor’s background grid.

– **Show Instance Links:** When enabled, the Node Editor draws a green connection between an instanced node and its parent.

– **Auto Remove Routers:** If routers are disconnected from a tool, they are automatically deleted from the Node Editor. This option is enabled by default to eliminate the need to delete orphaned routers.

– **Show Navigator:** Enabling this option displays a small overview window of the entire node tree in the Node Editor’s top-right corner. For more information, see the Navigator section in this chapter.

– **Auto Navigator:** The Navigator only appears when one or more nodes is outside the visible area of the Node Editor. For more information, see the Navigator section in this chapter.

– **Build Flow Vertically/Horizontally:** Node trees can be built either horizontally from left to right or vertically from top to bottom. Enabling one of these options determines whether new nodes are added beneath the current node or to the right of the current tool.

– **Orthogonal/Direct Pipes:** Use these two options to decide whether connections between nodes are drawn as Direct (straight) lines or Orthogonal (bent) lines.
Node Tooltips and the Status Bar

Even in simple node trees, it’s easy to forget some essential detail about the nodes in your comp. To help you figure out what everything’s for, you can hover the pointer over any node in the Node Editor to display information in the Status bar at the bottom of the Node Editor consisting of that node’s name, frame size, pixel aspect, resolution, and color depth.

The Status bar located beneath the Node Editor.

If you wait a few moments later, a more elaborate presentation of the same information appears within a floating tooltip in the Inspector. This tooltip gives you additional information about the Domain (Image and DoD) and the data range used by that clip.

The floating tooltip showing node information that appears within the Node Editor.
Chapter 67

Node Groups, Macros, and Fusion Templates

This chapter reveals how to use groups, macros, and templates in Fusion so working with complex effects becomes more organized, more efficient, and easier.

Contents

Groups
Creating Groups 1131
Deleting Groups 1131
Expanding and Collapsing Groups 1132
Panning and Scaling within Open Group Windows 1132
Ungrouping Nodes 1132
Saving and Reusing Groups 1132

Macros
Creating Macros 1133
Using Macros 1135
Re-Editing Macros 1135
Other Macro Examples 1135

Creating Fusion Templates
Getting Started with a Fusion Title Template 1135
Saving a Title Macro 1136
Using Your New Title Template 1139
Getting Started with a Fusion Transition Template 1140
Groups

When you work on complex visual effects, node trees can become sprawling and unwieldy, so grouping tools together can help you better organize all the nodes and connections. Groups are containers in your node tree that can hold multiple nodes, similar to the way a folder on your Desktop holds multiple files. There is no limit to the number of nodes that can be contained within a group, and you can even create subgroups within a group.

Creating Groups

Creating a group is as simple as selecting the nodes you want to group together and using the Group command.

To create a group:

1. Select the nodes you want grouped together.
2. Right-click one of the selected nodes and choose Group from the contextual menu (Command-G).

The selected nodes are collapsed into a group, which is displayed as a single node in the Node Editor. The Group node can have inputs and outputs, depending on the connections of the nodes within the group. The Group node only displays inputs for nodes that are already connected to nodes outside the group. Unconnected inputs inside the group will not have an Input knot displayed on the Group node.
Deleting Groups
Deleting a group is no different from deleting any other node in the Node Editor. Select a group and press Delete, Backspace, or Forward-Delete, and the group along with all nodes contained within it are removed from the node tree.

Expanding and Collapsing Groups
A collapsed group is represented by a single “stack” node in the node tree. If you want to modify any of the nodes inside the group, you can open the group by double-clicking it or by selecting the group node and pressing Command-E.

When you open a group, a floating window shows the nodes within that group. This floating window is its own Node Editor that can be resized, zoomed, and panned independently of the main Node Editor. Within the group window, you can select and adjust any node you want to, and even add, insert, and delete nodes while it is open. When you’re ready to collapse the group again, click the minimize button at the top left corner of the floating window, or use the keyboard shortcut (Cmd-E).

Panning and Scaling within Open Group Windows
You can pan and scale an open group window using the same mouse buttons you use to pan and scale the main Node Editor. However, when you’re working in an expanded group and simultaneously making changes to the main node tree, you may want to prevent the expanded group from being individually panned or scaled. Turning off the Position button at the right of the group title bar locks the group nodes to the size of the nodes in the rest of the overall node tree. Turning on this Position button lets you size group nodes independently of the rest of the node tree.

Ungrouping Nodes
If you decide you no longer need a particular group, or you simply find it easier to have constant access to all the nodes in the group at once, you can decompose or “ungroup” the group without deleting the nodes within it to eliminate the group but keep the contents in the Node Editor.

To ungroup nodes, do the following:
1. Right-click on the group.
2. Choose Ungroup from the contextual menu. The nodes inside the group are placed back in the main node tree.

Saving and Reusing Groups
One of the best features of groups is that every group and its settings can be saved for later use in other shots or projects. Groups and their settings can be recalled in various ways.

A good example of when you might want to Save and Load a group is in a studio with two or more compositing artists. A lead artist in your studio can set up the master comp and create a group specifically for keying greenscreen. That key group can then be passed to another artist who refines
the key, builds the mattes, and cleans up the clips. The setting can then be saved out and loaded back into the master comp. As versions are improved, these settings can be reloaded, updating the master comp.

**Methods of saving and reusing groups:**

- **To save a group:** Right-click a group and choose Settings > Save As from the contextual menu.
- **To reuse a group:** Drag it from your computer’s file browser directly into the Node Editor. This creates a new group node in the node tree with all the same nodes as the group you saved.
- **To load the settings from a saved group to another group with the same nodes:** Right-click a group in the Node Editor and choose Settings > Load from the contextual menu.

**In Fusion Studio, you can also save and reuse groups from the Bins window:**

- **To save a group:** Drag the group from the Node Editor into the opened Bin window. A dialog will appear to name the group setting file and the location where it should be saved on disk. The .settings file will be saved in the specified location and placed in the bins for easy access in the future.

**Macros**

Some effects aren’t built with one tool, but with an entire series of operations, sometimes in complex branches with interconnected parameter controls. Fusion provides many individual effects nodes for you to work with but gives users the ability to repackage them in different combinations as self-contained “bundles” that are either macros or groups. These “bundles” have several advantages:

- They reduce visual clutter in your node tree.
- They ensure proper user interaction by allowing you to restrict which controls from each node of the macro are available to the user.
- They improve productivity by allowing artists to quickly leverage solutions to common compositing challenges and creative adjustments that have already been built and saved.

Macros and groups are functionally similar, but they differ slightly in how they’re created and presented to the user. Groups can be thought of as a quick way of organizing a composition by reducing the visual complexity of a node tree. Macros, on the other hand, take longer to create because of how customizable they are, but they’re easier to reuse in other comps.

**Creating Macros**

While macros let you save complex functions for future use in very customized ways, they’re actually pretty easy to create.

**To make a macro from nodes in the Node Editor:**

1. Select the nodes you want to include in the macro you’re creating. Because the macro you’re creating will be for a specific purpose, the nodes you select should be connected together to produce a particular output from a specific set of inputs.

   **TIP:** If you want to control the order in which each node’s controls will appear in the macro you’re creating, Command-click each node in the order in which you want it to appear.

2. Right-click one of the selected nodes and choose Macro > Create Macro from the contextual menu.
A Macro Editor window appears, showing each node you selected as a list, in the order in which each node was selected.

![Macro Editor window](image)

The macro editor with a Blur node and Color Corrector node.

3. First, enter a name for the macro in the field at the top of the Macro Editor. This name should be short but descriptive of the macro’s purpose. No spaces are allowed, and you should avoid special characters.

4. Next, open the disclosure control to the left of each node that has controls you want to expose to the user and click the checkbox to the right of each node output, node input, and node control that you want to expose.

   The controls you check will be exposed to users in the order in which they appear in this list, so you can see how controlling the order in which you select nodes in Step 1, before you start editing your macro, is useful. Additionally, the inputs and outputs that were connected in your node tree are already checked, so if you like these becoming the inputs and outputs of the macro you’re creating, that part is done for you.

   For each control’s checkbox that you turn on, a series of fields to the left of that control’s row lets you edit the default value of that control as well as the minimum and maximum values that control will initially allow.

5. When you’re finished choosing controls, click Close.

6. A dialog prompts you to save the macro. Click Yes.

7. A Save Macro As dialog appears in which you can re-edit the Macro Name (if necessary), and choose a location for your macro.

   To have a macro appear in the Fusion page Effects Library Tools > Macros category, save it in the following locations:
   
   - **On macOS:** Macintosh HD/Users/username/Library/Application Support/Blackmagic Design/DaVinci Resolve/Fusion/Macros/
   
   - **On Windows:** C:\Users\username\AppData\Roaming\Blackmagic Design\DaVinci Resolve\Support\Fusion\Macros
   
   - **On Linux:** home/username/.local/share/DaVinciResolve/Fusion/Macros
To have a macro appear in the Fusion Studio Effects Library Tools > Macros category, save it in the following locations:

- **On macOS:** Macintosh HD/Users/username/Library/Application Support/Blackmagic Design/Fusion/Macros/
- **On Windows:** C:\Users\username\AppData\Roaming\Blackmagic Design\Fusion\Macros
- **On Linux:** home/username/fusion/BlackmagicDesign/Fusion/Macros

When you're done, click Save.

**Using Macros**

Macros can be added to a node tree using the Add Tool > Macros or Replace Tool > Macros submenus of the Node Editor contextual menu.

**Re-Editing Macros**

To re-edit an existing macro, just right-click anywhere within the Node Editor and choose the macro you want to edit from the Macro submenu of the same contextual menu. The Macro Editor appears, and you can make your changes and save the result.

**Groups Can Be Accessed Like Macros**

Groups can also be loaded from the Insert Tool > Macros submenu if you save a group’s .setting file to the Macros folder in your file system. For example, on macOS, the Macintosh HD/Library/Application Support/Blackmagic Design/DaVinci Resolve/Fusion/Macros/ directory.

**Other Macro Examples**

A macro can also be used as a custom LUT. Just copy the macro’s .setting file to the LUTs: folder, and the macro will be selectable in the viewers as a LUT. These LUT macros can be used for more than just a color adjustment; you could make a macro that does YUV 4:2:2 resampling, a resize, a sharpening filter, or just watermarking.

**Creating Fusion Templates**

The integration of Fusion into DaVinci Resolve has enabled the ability to create Fusion Titles, Transitions, Effects, and Generators templates for use in the Edit page. You can create these templates in the Fusion page or within Fusion Studio and then copy them into DaVinci Resolve. Fusion Titles, Generators, and Transition templates are essentially comps created in Fusion but editable in the Timeline of the Edit page with custom controls. This section shows you how it’s done.

**Getting Started with a Fusion Title Template**

The first part of creating a Fusion title template is to create a Fusion composition consisting of Fusion-generated objects assembled to create nearly any kind of title or generator you can imagine. If you're really ambitious, it can include animation. In this example, 3D titles and 2D titles have been combined into a show opener.
Building a composition to turn into a title template.

**Saving a Title Macro**

Macros are basically Fusion compositions that have been turned into self-contained nodes. Ordinarily, these nodes are used as building blocks inside of Fusion so that you can turn frequently-made compositing tricks that you use all the time into your own nodes. However, you can also use this macro functionality to build title templates for the Edit page.

Having built your composition, select every single node you want to include in that template except for the MediaIn and MediaOut nodes in DaVinci Resolve or Loader and Saver nodes in Fusion Studio.

**TIP:** If you want to control the order in which node controls will be displayed later on, you can Command-click each node you want to include in the macro, one by one, in the order in which you want controls from those nodes to appear. This is an extra step, but it keeps things better organized later on.
Having made this selection, right-click one of the selected nodes and choose Macro > Create Macro from the contextual menu.

Creating a macro from the selected nodes.

The Macro Editor window appears, filled to the brim with a hierarchical list of every parameter in the composition you’ve just selected.

The Macro Editor populated with the parameters of all the nodes you selected.
This list may look intimidating, but closing the disclosure control of the top Text1 node shows us what’s really going on.

![A simple list of all the nodes we’ve selected.](image)

Closing the top node’s parameters reveals a simple list of all the nodes we’ve selected. The Macro Editor is designed to let you choose which parameters you want to expose as custom editable controls for that macro. Whichever controls you choose will appear in the Inspector whenever you select that macro, or the node or clip that macro will become.

So all we have to do now is to turn on the checkboxes of all the parameters we’d like to be able to customize. For this example, we’ll check the Text3D node’s Styled Text checkbox, the Cloth node’s Diffuse Color, Green, and Blue checkboxes, and the SpotLight node’s Z Rotation checkbox, so that only the middle word of the template is editable, but we can also change its color and tilt its lighting (making a “swing-on” effect possible).

![Selecting the checkboxes of parameters we’d like to edit when using this as a template.](image)

Once we’ve turned on all the parameters we’d like to use in the eventual template, we click the Close button, and a Save Macro As dialog appears.

To have the Title template appear in the Effects Library > Titles category of DaVinci Resolve, save the macro in the following locations:

- **On macOS:** Macintosh HD/Users/username/Library/Application Support/Blackmagic Design/DaVinci Resolve/Fusion/Templates/Edit/Titles
- **On Windows:** C:\Users\username\AppData\Roaming\Blackmagic Design\DaVinci Resolve\Support\Fusion\Templates\Edit\Titles
- **On Linux:** home/username/.local/share/DaVinciResolve/Fusion/Templates/Edit/Titles
Choosing where to save a title template for the Edit page in DaVinci Resolve.

**Using Your New Title Template**

After you’ve saved your macro, you’ll need to quit and reopen DaVinci Resolve. When you open the Effects Library of the Edit page, you should see your new template inside the Titles category, ready to go in the Fusion Titles list.

Custom titles appear in the Fusion Titles section of the Effects Library.

Editing this template into the Timeline and opening the Inspector, we can see the parameters we enabled for editing, and we can use these to customize the template for our own purposes.
Customizing the template we made.

And that’s it!

**Getting Started with a Fusion Transition Template**

When creating a Fusion transition template, it’s easiest to start with an existing transition template and build off that. Three transitions are located in the Fusion Transitions category of the DaVinci Resolve Effects Library. The simplest transition is the Cross Dissolve, while the most complex example is the Slice Push.

The Fusion transition templates located in DaVinci Resolve’s Effects Library.
Creating a Fusion Transition Template

The three Fusion Transitions located in the DaVinci Resolve Effects Library are basically Fusion compositions that have been turned into macros. Ordinarily, macros are used as building blocks inside of Fusion so that you can turn frequently-made compositing tricks that you use all the time into your own nodes. However, you can also use this macro functionality to build transition templates for the DaVinci Resolve Edit page.

Once you apply a Fusion Transition in the Edit page, you can right-click it and choose Open in Fusion Page.

Right-clicking over a Fusion Transition in the DaVinci Resolve Edit page.

The Fusion page opens, displaying the node tree used to create the Fusion transition.

The Cross Dissolve node tree in Fusion.

The MediaIn 1 node represents the outgoing clip in the Edit page Timeline. The MediaIn 2 clip represents the incoming clip. You can modify or completely change the Cross Dissolve effect to create your own custom transition using any of Fusion’s nodes.

The Fusion Cross Dissolve node tree replaced with Transforms and a Merge node.

**TIP:** To modify the duration of the Fusion transition from the Edit page Timeline, you must apply the Resolve Parameter Modifier to any animated parameter. In place of keyframing the transition, you create the transition using the Scale and Offset parameters of the Resolve parameter modifier.
Updating a Fusion Transition

After modifying the transition in Fusion, you can choose to update the transition in the Timeline or create a new transition, which you save into the Edit page Effects Library. To update the transition, just return to the Edit page. The transition in the Edit page Timeline reflects the changes you make in the Fusion page.

Saving a New Fusion Transition

If after modifying the transition in Fusion, you need to save it to the Effects Library to reuse it on other transitions or other projects, you must make a macro and save it to the Transitions folder.

Start by selecting every node in the Node Editor that you want to include in the transition template, including the two MediaIn nodes and the MediaOut node.

**TIP:** Since the transition template must include the MediaIn and MediaOut nodes, the final steps for saving a transition template must be performed in DaVinci Resolve’s Fusion page and cannot be performed in Fusion Studio.

Having made this selection, right-click one of the selected nodes and choose Macro > Create Macro from the contextual menu.

The Macro Editor displaying the parameters of all the nodes you selected.

The Macro Editor window appears, displaying a hierarchical list of every parameter in the composition you’ve just selected. The order of nodes is based on the order they were selected in the Node Editor prior to creating the macro.

The Macro Editor is designed to let you choose which parameters you want to display as custom controls in the Edit page Inspector when the transition is applied.

For transitions, you can choose not to display any controls in the Inspector, allowing only duration adjustments in the Timeline. However, you can choose a simplified set of parameters for customization by enabling the checkboxes next to any parameter name.
Once you enable all the parameters you want to use in the eventual template, click the Close button, and a Save Macro As dialog appears. Here, you can enter the name of the transition, as it should appear in the Edit page Effects Library.

To have the transition template appear in the Effects Library > Fusion Transitions category of DaVinci Resolve, save the macro in the following locations:

- **On macOS:** Macintosh HD/Users/username/Library/Application Support/Blackmagic Design/DaVinci Resolve/Fusion/Templates/Edit/Transitions
- **On Windows:** C:\Users\username\AppData\Roaming\Blackmagic Design\DaVinci Resolve\Support\Fusion\Templates\Edit\Transitions
- **On Linux:** home/username/.local/share/DaVinciResolve/Fusion/Templates/Edit/Transitions

**Using Your New Transition Template**

After you've saved your macro, you'll need to quit and reopen DaVinci Resolve. When you open the Effects Library on the Edit page, the new transition template is listed in the Video Transitions category, in the Fusion Transitions list.

Applying this transition to a cut in the Timeline and opening the Inspector shows the parameters you enabled for editing, if any.

**Getting Started with a Fusion Generator Template**

There is one simple Noise Gradient Fusion Generator located in the Effects Library that you can use as a starting point for creating your own generators.
To open the Fusion Noise Gradient Generator in the Fusion page, do the following:

1. On the Edit page, drag the Fusion Noise Gradient Generator from the Effects Library to the Timeline.
2. Right-click over the Noise Gradient Generator and choose Open in Fusion Page from the pop-up menu.

The Fusion page opens, displaying the node tree that is used to create the Fusion Generator.

Creating a Fusion Generator Template

As easy as it is to begin with the Noise Gradient Generator template, you can just as easily start by adding a Fusion Composition Effect to a Timeline in the Edit page.

To begin creating a Fusion Generator Template with an empty Fusion composition, do the following:

1. On the Edit page, drag the Fusion Composition Effect from the Effects Library to the Timeline.
2. Right-click over the Composition Effect and choose Open in Fusion Page from the pop-up menu.

An empty Fusion page with a single MediaOut node opens, ready for you to create a Fusion Generator.

The Fusion Generator is a solid image generated from any number of tools combined to create a static or animated background. You can choose to combine gradient colors, masks, paint strokes, or particles in 2D or 3D to create the background generator you want.
Saving a New Fusion Generator

After creating the generator you want in Fusion, you need to save it to the Effects Library to reuse it in other projects from the Edit page. To do this, you must create a Macro and save it to the Generator folder.

Ordinarily, macros are used as building blocks inside of Fusion so that you can turn frequently-made compositing tricks that you use all the time into your own nodes. However, you also use this macro functionality to build Generator templates for the DaVinci Resolve Edit page.

Start by selecting every node in the Node Editor that you want to include in the Generator template including the MediaOut node.

Having made this selection, right-click one of the selected nodes and choose Macro > Create Macro from the contextual menu.

The Macro Editor window appears, displaying a hierarchical list of every parameter in the composition you’ve just selected. The order of nodes is based on the order they were selected in the Node Editor prior to creating the macro.

The Macro Editor is designed to let you choose which parameters you want to display as custom controls in the Edit page Inspector when the Generator is applied. You can choose a simplified set of parameters for customization by enabling the checkboxes next to any parameter name.

Once you enable all the parameters you want to use in the eventual template, click the Close button, and a Save Macro As dialog appears. Here, you can enter the name of the Transition, as it should appear in the Edit page Effects Library.

To have the Generator template appear in the Effects Library > Fusion Generators category of DaVinci Resolve, save the macro in the following locations:

- **On macOS**: Macintosh HD/Users/username/Library/Application Support/Blackmagic Design/ DaVinci Resolve/Fusion/Templates/Edit/Generators
- **On Windows**: C:/Users/username/AppData/Roaming\Blackmagic Design\DaVinci Resolve\ Support\Fusion\Templates\Edit\Generators
- **On Linux**: home/username/.local/share/DaVinciResolve/Fusion/Templates/Edit/Generators
Using Your New Generator Template

After you’ve saved your macro, you’ll need to quit and reopen DaVinci Resolve. When you open the Effects Library on the Edit page, the new Generator template is listed in the Generators category, in the Fusion Generators list.

Applying this Generator to the Timeline and opening the Inspector shows the parameters you enabled for editing, if any.

Creating a Fusion Effect Template

You start building a Fusion Effect template by bringing a clip from the Edit page Timeline into Fusion. This clip is only used for creating the template and will not be saved with the effect.

Once inside Fusion, you use Fusion’s nodes to create the effect you want. You can use a single node or a hundred, depending on the effect you want to create. For instance, using Fusion’s Color Correction nodes, you can create a simple color corrector you can use on the Edit page.

To create a simple Color Corrector effect, do the following:

1. Insert the Color Corrector node between the MediaIn and MediaOut nodes.
2. Select the Color Corrector node in the Node Editor, and then press Cmd-A to select the remaining nodes.
3. Right-click over any of the selected node and choose Macro > Create Macros from the contextual menu. Enabling the checkboxes in this window determines the parameters that appear in the Edit page Inspector.
4. The Macro Editor window opens. Here, you can enable the checkboxes for any parameters you want to be shown in the Edit page Inspector.
5. Enter the name of your effect at the top of the Macro Editor window.
6. To save the Macro, click Close at the bottom of the window, then click Yes in the dialog that appears asking you to save the changes.
The Macros must be saved into the correct folder for DaVinci Resolve to recognize the Macro as an effect.

**In the save dialog, save the Macro in the following locations:**

- **On macOS:** Macintosh HD/Users/username/Library/Application Support/Blackmagic Design/DaVinci Resolve/Fusion/Templates/Edit/Effects
- **On Windows:** C:\Users\username\AppData\Roaming\Blackmagic Design\DaVinci Resolve\Support\Fusion\Templates\Edit\Effects
- **On Linux:** home/username/local/share/DaVinciResolve/Fusion/Templates/Edit/Effects

To see the effect in the Edit page Effects Library, you’ll need to quit DaVinci Resolve and relaunch the application.

**Creating a Fusion Effect Template for Two or More Layers**

If the effect you want to create requires multiple images like a video wall, you start by creating a Fusion clip on the Edit page Timeline that includes the number of layers you want the effect to have. The clips are only used to create the number of image inputs for the template and will not be saved with the effect.

Once inside Fusion, use Fusion’s nodes to create the effect you want.

Save the Macro following the same steps you use for single clip effects. Enable any of the parameters you want to control in the Edit page. To be able to switch the order of video layers within the effect, make sure you have the Layer checkbox enabled for all the MediaIn nodes.

Once you’ve saved the Macro and relaunched DaVinci Resolve, to use the effect on multiple timeline layers, you must create a Fusion clip. The Fusion clip should contain the same number of layers the effect requires. The order of the Timeline layers, going from the bottom track to the top, matches the MediaIn numbers. For instance, video track 1 will match the position and appearance of MediaIn1, video track 2 matches MediaIn2 and so on. If you want to change how tracks map to MediaIn nodes, you can change the Layer number in the Inspector, assuming you enabled the MediaIn Layer checkbox when creating the Macro.

**Changing Durations of a Template**

After you make a template in Fusion, you may want to change its duration in the Edit or Cut page Timeline. Changing the duration when animation is involved can be complicated, so there are twoModifiers in Fusion that can help determine how keyframes react when the duration is updated in the Edit or Cut page Timeline.

**Anim Curves Modifier**

The Animation Curves Modifier (Anim Curves) is used to dynamically adjust the timing, values, and acceleration of an animation, even if you decide to change the duration of a Comp. Using this Modifier, it becomes infinitely easier to stretch or squash animations, create smooth motion, add bouncing properties, or mirror animations curves without the complexity of manually adjusting splines.

When creating Fusion templates for the Edit or Cut page in DaVinci Resolve, the Anim Curves Modifier allows the keyframed animation you’ve created in Fusion to stretch and squash appropriately as the transition, title, or effect’s duration changes on the Edit and Cut page Timelines.

**Keyframe Stretcher Modifier**

The Keyframe Stretcher modifier is primarily used when creating title templates in Fusion for use in DaVinci Resolve’s Edit or Cut page. The Keyframe Stretcher modifier is added to any animated parameter so that the Hold keyframes between the initial animation on screen and the final animation off-screen stretch when the template is trimmed in the Timeline. This allows the animation to retain its timing while the static portion of the title stretches to meet the new duration requirements.
Creating a Custom Template Icon

It is possible to create a custom icon that is embedded with your template thumbnail in the Effects Library, instead of the default first three letters of the template name.

To create a simple Custom Template Icon:

1. Create a .png file of the icon you want to use for the template. The recommended size is 104 x 58 pixels, but any image will be resized to fit.
2. Name the file exactly the same name as your template, just with a .png extension rather than a .setting extension.
3. Place the .png image in the same directory as your template.

When you restart DaVinci Resolve, the icon you created will be embedded in the template thumbnail across all the Effects Libraries in the program.

A Custom Icon added to a fisheye template, before (above) and after (below)

Using Fusion Template Bundles

For ease in distributing templates to other Fusion users, multiple templates can now be bundled together into a single .drfx file. This file can then be imported back into another Fusion workstation easily to ensure that all custom templates are the same between computers.

Creating a Fusion Template Bundle requires using a specific directory structure and using your operating systems file browser and .zip compression utility. The directory structure is listed below, and you can always find a specific folder from within Fusion by right-clicking on any bin in the Effect Library and selecting Show Folder.

Folder structure for Templates used in the Edit page:

- Edit
- Effects
- Generators
- Titles
- Transitions

Folder structure for Templates used in the Fusion page:

- Fusion

To create a Fusion Template Bundle:

1. In your OS, create a folder structure above that includes the specific folder for the type of templates you want to be in the bundle. For example, if you have a transition and two effects templates, you would create an Edit folder, and two subfolders inside it named Transitions and Effects.
2. Copy your template (.setting) files into the appropriate directories. You can also include icon files and any associated assets as well.
3 Use your OS zip compression utility to create a .zip file of the directory structure.

4 Rename the .zip file in your OS with the " .drfx" extension instead of .zip. The file icon should change to reflect the new extension.

**To import a Fusion Template Bundle:**

1 Double-click on a .drfx file in your OS. DaVinci Resolve will launch and a dialogue box will appear asking if you want to install the template bundle.

2 Drag to the .drfx file from your OS directly into the Fusion page in DaVinci Resolve. A dialogue box will appear asking if you want to install the template bundle.

**To delete a Fusion Template Bundle:**

1 Navigate to the appropriate template directory in your file browser.

2 Delete the .drfx file.

**IMPORTANT**

The Fusion Template Bundle contains all the templates in one file. It does not uncompress them into separate template files again. Therefore if you delete the .drfx file, all associated templates inside that bundle will be removed as well.
Chapter 68

Using Viewers

This chapter covers working with viewers in Fusion, including using onscreen controls and toolbars, creating groups and subviews, managing viewer Lookup Tables (LUTs), working with the 3D viewer, and setting up viewer preferences and options.

Contents

Viewer Overview 1152
Single vs. Dual Viewers 1152
Floating Viewers in Fusion Studio 1153
Video Output 1153
Clean Feed 1153
Loading Nodes into Viewers 1153
Clearing Viewers 1154
Position and Layout 1154
The Viewer Divider 1154
Zooming and Panning into Viewers 1155
Flipbook Previews 1155
Creating Flipbook Previews 1155
Playing Flipbook Previews 1156
Removing Flipbook Previews 1157
Flipbook Preview Render Settings 1157
Onscreen Controls 1158
Showing and Hiding Onscreen Controls 1158
Making Fine Adjustments to Onscreen Controls 1159
Toolbars 1159
Viewer Toolbar 1159
Node Toolbars 1159
A/B Buffers 1160
Flipping between Buffers 1160
Split Wipes between Buffers 1160
Moving the Wipe Divider 1161
Viewer Overview

Viewers in Fusion display the current frame of the current composition in a variety of ways to help you see what you’re doing and evaluate the final result of your compositing artistry. Viewers display 2D images, but they can also display a 3D environment using a 3D View as well as a special Quad viewer to help you effectively work in three dimensions.

Additionally, you can expose “subviews” including color inspectors, magnifiers, waveforms, histograms, and vectorscopes to help you analyze the image as you work.

Single vs. Dual Viewers

By default, there are two viewers positioned side by side across the top of the window. However, you can use the Single/Dual Viewer button to toggle between displaying a single viewer or two viewers displayed side by side.
Floating Viewers in Fusion Studio

In addition to the dual views above the Node Editor, Fusion Studio provides the option to use an unlimited number of floating viewers. These floating viewers are excellent for taking full advantage of a dual monitor configuration. Floating viewers can also be set to full-screen mode to make the best use of screen real estate.

To create a new floating display view, select Window > New View from the menu bar at the top of the screen. The position and configuration of the new view can be saved in the layout preferences, if required.

Video Output

When using DaVinci Resolve or Fusion Studio, if Blackmagic video hardware is present in the computer, then you can select a node to preview directly on that display. While video output can’t be used for manipulating onscreen controls such as center crosshairs or spline control points, they’re extremely valuable for evaluating your composition via the output format, and for determining image accuracy using a properly calibrated display.

The video hardware is configured from the DaVinci Resolve and Fusion Studio preferences.

Clean Feed

When using DaVinci Resolve with dual computer monitors, a full-screen viewer can be displayed on the secondary monitor from the Fusion page. This displays a third view indicator button under each node to control what is shown on the second display. To activate this monitor, make sure you do not have Dual Screen enabled under the Workspace menu and then select Workspace > Video Clean Feed and select your second computer display from the submenu.

Loading Nodes into Viewers

The Fusion page in DaVinci Resolve and Fusion Studio show two different things when you first open each application. When you first open the Fusion page, the output of the current empty composition (the MediaOut1 node) is usually showing in viewer 2. If you’re in dual-viewer mode, viewer 1 remains empty until you assign a node to one of them. In Fusion Studio, because there are no nodes when you first begin a comp, nothing is displayed in the viewers.

To load specific nodes into specific viewers, do one of the following:

– Hover the pointer over a node, and click one of two buttons that appear at the bottom-left of the node.
– Click once to select a node, and press 1 (for the left viewer) or 2 (for the right viewer).
– Right-click a node and choose View On > None/Left View/Right View in the contextual menu.
– Right-click the control header of a node in the Inspector, and choose View On > None/Left View/Right View from the contextual menu.
– Drag a node and drop it over the viewer you’d like to load it into (this is great for tablet users).

When a node is being viewed, a View Indicator button appears at the bottom left. This is the same control that appears when you hover the pointer over a node. Not only does this control let you know which nodes are loaded into which viewer, but they also expose little round buttons for changing which viewer they appear in.
Clearing Viewers

To clear an image from a viewer, click in the viewer to make it active; a light purple outline is displayed around the active panel. With the viewer active, press the Tilde (\~) key. This key is usually found to the left of the 1 key on U.S. keyboards. The fastest way to remove all images from all viewers is to make sure none of the viewers is the active panel, and then press the Tilde key.

Position and Layout

When you resize and change the layout of viewers in the composition, that configuration is always saved with the composition. So each time you open the composition, the size and layout is remembered. You can prevent this behavior by disabling the Recall Layout checkbox in the Fusion Global Layout preferences.

If you want all new compositions to open with a certain viewer layout, you can configure the layout of the two primary viewers, and then use the Grab Document Layout button in the Fusion Global Layout preferences to remember the layout for any new compositions. To save the position and size of floating viewers, you use the Grab Program Layout button. Finally, if you want to have the floating viewers opened automatically when you open Fusion, enable the Create Floating Views checkbox.

The Viewer Divider

You can change the relative sizes of the left and right viewers using the horizontal viewer divider that runs between them. Drag the viewer divider to increase or decrease the amount of space used by one viewer. The adjacent viewer will adjust to accommodate the new layout.

The amount of vertical space available for both viewers can be adjusted by dragging the horizontal scrollbar between the viewers and the work area below them.
Zooming and Panning into Viewers

There are standardized methods of zooming into and panning around viewers when you need a closer look at the situation. These methods also work with the Node Editor, Spline Editor, and Keyframes Editor.

Methods of panning viewers:
- Middle-click and drag to pan around the viewer.
- Hold down Shift and Command and drag the viewer to pan.
- Drag two fingers on a trackpad to pan.

Methods of scaling viewers:
- Click a viewer and press the Equals key (=) to zoom in, and the Minus key (-) to zoom out.
- Press the middle and left mouse buttons simultaneously and drag left or right to resize the viewer.
- Hold down the Command key and use your pointer’s scroll control to resize the viewer.
- Hold down the Command key and drag two fingers on a trackpad to resize the viewer.
- Hold down the middle mouse button, and then click the left mouse button to zoom in, or click the right button to zoom out. The scaling uses a fixed amount, centered on the position of the cursor.
- Click a viewer and press Command-1 to resize the image in the viewer to 100 percent.
- Click a viewer and press Command-F or Command-1 to reset the image in the viewer to fit the viewer.
- Click the Scale Viewer menu and choose Fit or a percentage.
- Right-click on a viewer and choose an option from the Scale submenu of the contextual menu. This includes a Custom Scale command that lets you type your own scale percentage.

Methods of spinning 3D viewers:
- In 3D Perspective view, hold down the Shift key and drag to spin the stage around.

Flipbook Previews

As you build increasingly complex compositions, and you find yourself needing to preview specific branches of your node tree to get a sense of how various details you’re working on are looking, you may find it useful to create targeted RAM previews at various levels of quality right in the viewer by creating a RAM Flipbook. RAM Flipbook Previews are preview renders that exist entirely within RAM and allow you to render a node’s output at differing levels of quality for quick processing in order to watch a real-time preview.

Creating Flipbook Previews

Creating a Flipbook Preview is relatively fast, once you know where to look.

To create a Flipbook Preview:
1. Choose the node in your node tree that you want to preview by doing one of the following:
   - Hold down the Option key while dragging a node into the viewer.
   - Right-click a node and choose an option from the Create/Play Preview submenu in the contextual menu.
When the Preview Render dialog opens, choose the quality, resolution, and motion blur settings you want to use for the Flipbook Preview.

When you’ve chosen the settings you want to use, click Start Render. The current frame range of the Time Ruler is rendered using the settings you’ve selected, and the result is viewable in the viewer you selected or dragged into.

Once you’ve created a Flipbook Preview within a particular viewer, right-clicking that viewer presents Flipbook-specific commands and options to Play, Loop, or Ping-Pong the Flipbook, to open it Full Screen, to Show Frame Numbers, and to eliminate it.

**TIP:** If you want to create a Flipbook Preview and bypass the Render Settings dialog by just using either the default setting or the settings that were chosen last, hold down Shift-Option while you drag a node into the viewer. The Settings dialog will not appear, and rendering the preview will start right away.

---

### Playing Flipbook Previews

While the Flipbook Preview is loaded into a viewer, or open in full-screen mode, you can play or scrub through it using the mouse and the keyboard.

**To play back a Flipbook using the mouse, do the following:**
- Double-click in the viewer to start playback.

**To scrub through a Flipbook using the mouse, do the following:**
- Hold down the right mouse button down and drag left or right to scrub through frames.

**To play back a Flipbook using the keyboard, do one of the following:**
- Press the Spacebar to start or stop playback.
- Hold Shift and press the Spacebar to play in reverse.

**To scrub through a Flipbook frame-by-frame using the keyboard, do one of the following:**
- Press the Left or Right Arrow keys to move to the previous or next frame.
- Hold Shift and press the Left or Right Arrow keys to jump back or forward 10 frames.
- Press Command-Left Arrow to jump to the first frame.
- Press Command-Right Arrow to jump to the last frame.
Removing Flipbook Previews

Once you create a Flipbook Preview, you need to know how to clear it from RAM.

To eliminate a Flipbook you've created:
  – Right-click within a viewer containing a Flipbook Preview, and choose Remove Preview.

Flipbook Preview Render Settings

This section covers all the settings available for rendering Flipbook Previews to RAM.

Settings

The Settings section of the Preview Render dialog includes three buttons that determine the overall quality and appearance of your Flipbook Preview. These buttons also have a significant impact on render times.

  – **HiQ**: When enabled, this setting renders the preview in full image quality. If you need to see what the final output of a node would look like, then you would enable the HiQ setting. If you are producing a rough preview to test animation, you can save yourself time by disabling this setting.
  
  – **MB**: The MB in this setting stands for Motion Blur. When enabled, this setting renders with motion blur applied if any node is set to produce motion blur. If you are generating a rough preview and you aren’t concerned with the motion blur for animated elements, then you can save yourself time by disabling this setting.
  
  – **Some**: When Some is enabled, only the nodes specifically needed to produce the image of the node you're previewing are rendered.

Size

Since RAM Flipbook Previews use RAM, it’s helpful to know how many frames you can render into RAM before you run out of memory. The Flipbook Preview dialog calculates the currently available memory and displays how many frames will fit into RAM. If you have a small amount of RAM in your computer and you cannot render the entire range of frames you want, you can choose to lower the resolution to a setting that delivers the best quality/duration ratio for your preview.

Network

Network rendering is only available in Fusion Studio. For more information on network rendering, see Chapter 65, “Rendering Using Saver Nodes” in the DaVinci Resolve Reference Manual or Chapter 4 in the Fusion Reference Manual.

Shoot On

Sometimes you may not want to render every single frame, but instead every second, third, or fourth frame to save render time and get faster feedback. You can use the Step parameter to determine the interval at which frames are rendered.

Frame Range

This field defaults to the current Render Range In/Out set in the Time Ruler to determine the start and end frames for rendering. You can modify the range to render more or fewer frames.

Configurations

Once you’ve created a useful preview configuration, you can save it for later use by clicking the Add button, giving it a name, and clicking OK.
Updating a Preview

This option is designed for the interactive frame-by-frame work of rotoscoping and painting. Right-click over a preview in the viewer and choose Update from its contextual menu. When active, any frames that are modified on the previewed node are automatically updated in the preview’s playback. This lets you reserve the RAM for playback. You can keep it playing on a loop or ping-pong while you work in another viewer.

Onscreen Controls

When it comes to adjusting images, the Control Panel provides very precise numerical values, but sometimes visually positioning an element using onscreen controls can get you where you want to go with less tweaking. The viewers show onscreen controls for manipulating the parameters of the currently selected node. Common onscreen controls include crosshairs, angle indicators, polylines, and paint strokes. Each of these controls can be manipulated directly in the viewer using the mouse or keyboard.

The Angle preview control

The controls shown in viewers are determined by which nodes are selected, not by the node displayed in the viewer. For example, a downstream blur is easily viewed while manipulating the controls for a selected polygon mask or merge. If multiple nodes are selected, the controls for every selected node are shown simultaneously.

Showing and Hiding Onscreen Controls

The onscreen controls for a viewer can be hidden so they don’t interfere with viewing the image.

To toggle the visibility of onscreen controls, do one of the following:

– Click a viewer’s Option menu and choose Show Controls to toggle the controls on or off.
– Right-click in a viewer and choose Options > Show Controls from the contextual menu.
– Select a viewer and press Command-K.

Enabling/Disabling Onscreen Controls in Specific Nodes

Some nodes, like masks, allow disabling of their onscreen controls on a per-node basis, since you often use multiple Polygon nodes to organize and animate masks.

You can disable some nodes, like the Polygon node, on a per-node basis.
Making Fine Adjustments to Onscreen Controls

If you want the visual guidance of onscreen controls with the precision of the Inspector, you can use different keyboard modifiers.

- Up and Down Arrow keys can be used to adjust the vertical position of an onscreen control by small steps.
- Holding down the Command key while using the Up and Down Arrow keys reduces the scale of each step by a factor of ten. Holding Shift increases the scale of each step by a factor of ten.

Toolbars

There are two toolbars in the viewer: a viewer toolbar, which always appears at the top of each viewer and gives you control over what that viewer shows, and an optional node toolbar that appears underneath that gives you contextual controls based on the node you’ve selected in the Node Editor.

Viewer Toolbar

A viewer toolbar runs across the top of each viewer, providing access to many of the most commonly used viewer-related settings, as well as an indication of the status of many of the most important settings. Most of the menus and buttons found on this toolbar are described in detail throughout this chapter.

Node Toolbars

In addition to the viewer toolbar, a node toolbar is displayed underneath, at the top of the viewer display area, whenever you select a node that exposes special nodes. Examples of nodes that expose a toolbar include the text, masks, paths, paint strokes, and the 3D environment.

Customizing the Node Toolbar

If you want to change the size of the buttons that appear in the Node toolbar, or turn on text names for each node, you can right-click anywhere in the empty area of the toolbar and choose new settings from the Icon Size and Button Style submenus in the contextual menu.
A/B Buffers

Each viewer has two buffers, each of which can contain images from different nodes, enabling easy comparison of two different nodes within the same viewer by either toggling between buffers, or via an adjustable split-wipe. Each buffer can be considered a complete and separate viewer within the same viewer pane. The A buffer is always shown by default, so when you first load a node into a viewer, the image loads into the A buffer.

Flipping between Buffers

Switching between buffers is easy, either to view a different image while keeping another image handy, or to flip between the original image and the affected image for comparison.

To switch between buffers, do one of the following:

- Select a viewer and press comma (,) to select the A buffer or press period (.) to select the B buffer.
- Click the Buffer menu and choose either Switch to A View or Switch to B View.

TIP: Each buffer can be set to different display settings—for example, showing different channels or different viewing LUTs, either applied to different nodes or applied to two buffered versions of the same node.

Split Wipes between Buffers

You can also wipe between both buffers, providing a more direct means of comparison.

To wipe between buffers, do one of the following:

1. Prepare to wipe between two images by loading different nodes into each buffer, or load the same node with different viewer options into each buffer.
2. To toggle the split wipe on or off, do one of the following:
   a. Click the Switch to Split Wipe View button.
   b. Press Forward Slash (/).
3. To adjust the wipe, do one of the following:
   a. Move the center of the wipe by dragging the center handle of the wipe divider.
   b. Press Command-Option and click anywhere in the viewer to jump the wipe divider to that location.
   c. Change the angle or the wipe by dragging the wipe divider. Dragging the wipe divider while holding the Shift key snaps it to the nearest 45-degree angle.
   d. Panning or zooming the viewer pans and zooms both buffers together.
(Optional) If you want to change the image that’s displayed on that side of the split, you can drag new nodes onto either half of the viewer.

To turn off the wipe, click the Switch to Split Wipe View button again (or press `/`).

Even when you wipe, you can choose different display channels, view LUTs, or other display options for each buffer individually by clicking on the half of the wipe you want to alter, and then choosing the options you want that buffer to use. This allows easy comparison of different channels, LUTs, or other viewer settings while wiping the same image, or different images.

**Moving the Wipe Divider**

Occasionally, you will have either zoomed in or panned so far from the viewer divider that it’s no longer visible in the viewer. Holding down Command-Option and clicking anywhere in the image will cause the viewer divider to jump to the current position of the pointer.

**Subviews**

A subview is a “mini” viewer that appears within the main viewer. A subview is usually used to show different information about the image.
For example, the RGB channels can be viewed in the main viewer, while the alpha channel is displayed in a subview. For the most part, the subview is a fully functional miniature viewer, with its own contextual menu and options. It responds to the same keyboard shortcuts and navigation controls as any other viewer. However, there are several view types designed for use only in the subview, including the Navigator, Magnifier, Color Inspector, and Image Info.

**Showing and Hiding Subviews**

Subviews are easily shown and hidden.

To enable the currently selected subview in the Subview menu of a viewer, do one of the following:

- Click the Subview button in the View toolbar.
- Choose Views > Subview > Enabled from the contextual menu.
- Click a viewer, and press the V key.

![The Subview button in the viewer toolbar](image)

**Changing the Subview Type**

The Subview button enables and disables the subview, which usually shows the last subview you chose. You can change this at any time.

To change which subview type is displayed, do one of the following:

- Click the small arrow to the right of the Subview button to open its menu and choose which subview you want.
- Right-click within a subview to bring up the subview’s contextual menu.

The Subview drop-down menu and contextual menu show all the available subview types. Once you choose an option from the list, that view will be displayed in the subview, and the Subview button will show and hide it as you wish.

**Swapping the Subview with the Main View**

It’s possible to swap the contents of the main viewer and the subview for select subview types. However, certain view types, such as the Color Inspector and Magnifier, can only be used in the subview. In these cases, the swap will not take place.

To swap the contents of the subview with the main view, do one of the following:

- Press Shift-V.
- Right-click in a viewer and choose Views > SubView > Swap from the contextual menu.
Viewer and Subview Types

Viewers can be changed to show a variety of different information about the image, but not all view types are available at all times. For example, the 3D Viewer is not available for a 2D node, and some of the measurement viewers are available only as subviews. Below is detailed information about the different view types available.

2D Viewer

The 2D Viewer is the default type for showing images. When used as a subview, a different node than the one used in the main viewer can be displayed by dragging the node into the subview.

This is the only subview type that is not just a different view of the same node in the main viewer.

3D Image Viewer

The 3D Image Viewer is available when viewing a node from the 3D category.

Histogram

The Histogram Viewer is an analysis node that can be used to identify problems with the contrast and dynamic range in an image. The graph shows the frequency distribution of colors in the image, including out-of-range colors in floating-point images. The horizontal axis shows the colors from shadows to highlights. The vertical axis shows the number of pixels in the image that occur at each level.

The Histogram Viewer will also display gradient information. You can use the From Image and Perturb modifiers to output gradients. If you need to see the gradient represented in a histogram, drag the modifier’s title bar into the viewer.
3D Histogram

The more advanced 3D Histogram Viewer shows the color distribution in an image within a 3D cube. One advantage to a 3D Histogram is that it can accurately represent the out-of-range colors commonly found in floating-point and high-dynamic-range images. It can also be used to look at vector images like position, normal, velocity, and so on.

To rotate within a 3D Histogram, do one of the following:
- Hold down the Option key, and drag left or right using the middle mouse button.
- Hold down the middle and right mouse buttons while dragging.

Vectorscope

The Vectorscope Viewer duplicates the behavior of a specific type of video test equipment, displaying a circular graph that helps to visualize the intensity of chrominance signals.
Waveform
The Waveform Viewer duplicates the behavior of a specific type of video test equipment, displaying a line or bar graph that helps to visualize the voltage or luminance of a broadcast signal.

Navigator
The Navigator can only be used in a subview. It provides a small overview of the entire image, with a rectangle that indicates the portion of the image that is actually visible in the main viewer. This is useful when zooming in on an image in the main view.

Magnifier
The Magnifier can be used only in a subview. It shows a zoomed-in version of the pixels under the cursor in the main viewer.
Image Info
The Image Info view can only be used in a subview. The Image Info tab shows a horizontal bar across the top of the image with information about the frame size, pixel aspect, and color depth of the viewed image.

Color Inspector
The Color Inspector can only be used in a subview. The Color Inspector shows information about the color channels of the pixel under the cursor. It will show all channels present, even the auxiliary channels such as Z buffer, XYZ normals, and UV mapping channels.

Metadata
The content of this subview is based entirely on the amount of metadata in your image. Most Loaders will give the color space and file path for the image. Much more information can be displayed if it exists in the image.
Viewing Selective Channels

When compositing, you often deal with individual color components or channels in an image as much as you deal with the full RGB color of the entire image. The viewers and subviews can display the isolated color, alpha, depth channels, and even auxiliary channels that make up the image.

Viewing Color Channels

The default view is the full RGB color channel, but to change the channel that is displayed you can use the Channel toolbar button, the viewer’s contextual menu, or keyboard shortcuts.

To toggle between RGB and alpha channels in the active viewer:
– Click the Color button in the viewer toolbar to toggle between full RGB color and that image’s alpha channel.

To toggle the channel that’s displayed in the active viewer:
– Click the arrow to the right of the Color button to choose a specific channel to view from the list of available channels in the current image.
– Click the viewer you want to toggle, and press one of the following keyboard shortcuts;
  C - Full RGB color display
  R - Display red channel
  G - Display green channel
  B - Display blue channel
  A - Display alpha channel
  Z - Display Z-buffer channel

Viewing Auxiliary Channels

The viewers support RGBA and Z channels using keyboard shortcuts, but they support other channels as well. File formats such as OpenEXR often include auxiliary image data that provide more control and compositing options when working with rendered 3D images. To view auxiliary image data in a viewer, click the arrow to the right of the RGB button to display the drop-down menu or right-click in the viewer and choose an option from the Channels submenu of the contextual menu.
The 3D Viewer

Building a composite in 3D space has different requirements from traditional 2D compositing. When a node from the 3D category or some particle systems is selected, a 3D Viewer is used to display the scene. The 3D Viewer shows a representation of a composite in a true GPU-accelerated 3D environment.


Panning, Scaling, and Rotating a 3D Viewer

For the most part, navigation in the 3D Viewer is similar to the navigation in the 2D Viewer. Panning and zooming work with the same controls even though you’re moving within a 3D space. However, when viewing a 3D scene, panning changes the point of view and thus the center point for scaling and rotation, too. A combination of panning and rotation will allow you to move the point of view anywhere in the scene.

Another small change is that there’s a lower limit to the scale of a 3D scene. Continuing to zoom in past this limit will instead move (“dolly”) the point of view forward. The mouse wheel will move forward slowly, and the keyboard will move more quickly.

Critically, the 3D Viewer gives you additional control to rotate the viewer within the three dimensions of the scene to better see your scene from different angles as you work.

To rotate within a 3D Viewer, do one of the following:

- Hold down the Option key and drag left or right using the middle mouse button.
- Hold down the middle and right mouse buttons while dragging.

The rotation is centered on the middle of the view.

**TIP:** These rotation controls can be used with the 3D Histogram subview as well.

Viewing Objects via Wireframe

3D composites not only work with 2D images on image planes but can also integrate true geometry, such as that generated by the Particle system, Text 3D node, imported FBX meshes, and basic primitives from the 3D toolset. Using a Wireframe view helps to see through a mesh or see the density of the geometry. It is much easier to see a change in the Subdivision level of an ImagePlane3D in wireframe than viewing the rendered image.

To display 3D geometry in wireframe, do the following:

- Right-click the 3D Viewer and choose 3D Options > Wireframe from the contextual menu.

Changing the POV of a 3D Viewer

Compositing a 3D scene often requires that you view the scene from different angles to make sure the position and animation are what you want. While the 3D Viewer uses a perspective camera that allows you to look at the 3D scene from any angle, you can also switch the 3D Viewer to view from the front, top, left, or right side of the scene; these are collectively called Orthographic views.

Additionally, if you have a camera or spotlight in your scene, you can switch the viewer to face the scene from the point of view of those objects.
To change the 3D viewpoints:
- Right-click the viewer and choose an option from the Camera submenu of the contextual menu. The choices include Perspective, Front, Top, Left, and Right.

Changing Cameras in a 3D Viewer
If you have one or more camera objects in the 3D scene, they will be listed as options in the contextual menu. Spotlights and other lights or objects in the scene will be listed in the Other submenu. If you choose any one of these objects, the 3D Viewer jumps to display the scene from the point of view of the chosen object. While looking "through" an object, rotating, panning, or zooming, the viewer will instead change the rotation, position, and scale of the camera, light, or other object.

Copying a Viewer’s POV to a Camera
There are many times you will have used the default perspective view to set up your scene and then want that point of view (POV) to become your main camera’s point of view. You can easily position and orient a camera, light, or other object to match the current point of view shown in the viewer using the Copy PoV To command.

To copy the point of view in the viewer to a camera, do the following:
1. Set up a 3D Viewer with the point of view you want by zooming, panning, and rotating the viewer.
2. Add a camera to your 3D scene.
3. Right-click anywhere within the 3D Viewer and choose Camera > Copy PoV To > Camera3DNameOfCamera from the contextual menu.

The Camera3D’s controls will inherit the viewer’s position and angle values.

TIP: The Copy PoV To command uses the object’s own coordinate space; any transformations performed downstream by another node are not taken into account.

POV Labels
As you switch the POV of the viewer, you can keep track of which POV is currently displayed via a text label at the bottom-left corner of the viewer. Right-clicking directly on this label, or on the axis control above it, acts as a shortcut to the Camera submenu, allowing you to easily choose another viewpoint.
Lighting and Shadows in 3D Viewers

Before you add lights to a 3D scene, default lighting is provided. This basic, flat lighting allows you to see the shading on objects without requiring you to add and set up lights as you work in the 3D Viewer. Additionally, shadows are hidden by default. Once you start adding lights of your own, you need to switch modes to see what they affect as you work.

To see the effects of the default light on the scene:
- Right-click within the 3D Viewer and choose 3D Options > Default Lights from the contextual menu.

When you’re ready to add your own lighting to a scene, you can connect light nodes in various ways to a Merge 3D node for the scene you’re working on. Once you connect a light to a Merge 3D node, you need to switch the 3D Viewer over to showing the new, proper lighting.

To toggle lighting rendering within a 3D scene:
- Right-click within the 3D Viewer and choose 3D Options > Lighting from the contextual menu.

TIP: Attempting to load a Light node into a viewer all by itself will result in an empty scene, with nothing illuminated. To see the effects of lights, you must view the Merge 3D node the light is connected to.

Similar to lights, the default 3D Viewer has shadows turned off. To see shadows cast from the lighting you’ve created, you must turn them on.
To toggle shadows rendering within a 3D scene:
- Right-click within the 3D Viewer and choose 3D Options > Shadows from the contextual menu. Enabling shadows will automatically turn on lighting, if it is not already turned on.

NOTE: The shadows shown in the 3D Viewer are always hard edged. Soft shadows are available for output to the rest of your composition in the software renderer of the Renderer3D node.

Transparency in 3D Viewers

Image planes and 3D objects are obscured by other objects in a scene depending on the X, Y, and Z position coordinates of each object in 3D space. The default method used to determine which polygons are hidden and which are shown based on these coordinates is called Z-buffering.

Z-buffering is extremely fast but not always accurate when dealing with multiple transparent layers in a scene. Fortunately, there is another option for more complex 3D scenes with transparency: Sorted. The Sorted method can be significantly slower in some scenes but will provide more accurate results no matter how many layers of transparency happen to be in a scene.

The default behavior in the viewer is to use Z-buffering, but if your scene requires the Sorted method, you can easily change this.

To choose a Sorted method of 3D compositing:
- Right-click anywhere within the 3D Viewer and choose one of the options in the Transparency submenu of the contextual menu;
  - Quick Sort: Reorders the polygons in the scene serially, from back to front, to produce a reasonably accurate rendering of transparency.
  - Full Sort: Renders every polygon in Z order to produce the most accurate rendering of transparency.

Grid

The 3D Viewer displays a grid that’s used to provide a plane of reference in the 3D scene. By default, the grid is 24 x 24 units in size, centered on the origin at (0,0,0), and subdivided into large squares of 2 units with small squares of 0.25 units each. These defaults can be altered in the 3D View panel of the Fusion Settings window, available from the Fusion menu.
To toggle the grid on and off:
– Right-click anywhere within the 3D Viewer and choose 3D Options > Grid from the contextual menu.

The default grid of the 3D Viewer grid with its origin at x = 0, y = 0 and z = 0

Vertex Normals

Normals indicate what direction each vertex of 3D geometry is facing, and they are used when calculating lighting and texturing on an object. When viewing any kind of 3D geometry, including an image plane or a full FBX mesh, you can display the normals for each object in a scene.

To view the normals in a scene:
– Right-click anywhere within the viewer and choose 3D Options > Vertex Normals from the contextual menu.

The normals viewed in a 3D scene

Quad View

3D compositing often requires you to view the scene from different points of view to better control transformations in three dimensions. While you can switch the 3D Viewer to different points of view, doing so frequently can become cumbersome. Happily, you can instead enable a Quad view, which divides the viewer into four panes. These panes can then display four different angles of the scene at one time.
To toggle the display of the Quad view, do one of the following:

– Right-click anywhere within the viewer and choose Views > Quad View from the contextual menu.

– Press Shift-Q.

A Quad view of a 3D scene

While there are four panes in the Quad view, they all show the same scene. When assigning views within a Quad view, you can choose between displaying Front, Left, Top, Bottom, and Perspective orthographic views, or you can choose the view through any camera or spotlight that’s present in the scene.

To assign different views to panes of a Quad view, do one of the following:

– Right-click directly on the POV label at the bottom left of the pane you want to reassign, and choose another camera, light, or Point of View from the contextual menu.

Quad View Layouts

There are a variety of Quad view layouts, ranging from four equally sized panels to having three small panels across the bottom of a larger single panel.

To switch to a different Quad view layout, do the following:

1. Enable the Quad view.
2. Right-click anywhere within the viewer and choose an option from the Views > Quad Layouts submenu of the contextual menu.

Using Quad Views for 2D Scenes

Quad views aren’t only useful for 3D scenes. They can also be used with 2D scenes, with each pane showing a different image channel or subview type. For example, one pane can show the image while the other panes show the alpha channel, a vectorscope, and a histogram.

To assign different channels or subviews to panes of a Quad view for a 2D scene:

1. Right-click in a viewer and choose Views > Quad View.
2. Click once in the pane you want to reassign.
3. Do one of the following:
   a. Choose a channel from the Channel Viewer menu.
   b. Right-click in the viewer and choose Views, and then choose a Subview from the submenu.
Guides

Guides are onscreen overlays used to help you compose elements within a boundary or along the center vertical and horizontal axes. While guides are displayed in the viewer, they’re not rendered into the scene. There are four commonly used guides that can be displayed, including Monitor Safety, Safe Title, Center, and Film.

Methods of using guides:

– **To display guides in a viewer:** Right-click in the viewer and then choose Guides > Show Guides from the contextual menu, or press Command-G.

– **To change the aspect ratio of the displayed guides:** Right-click in the viewer and then choose an option from the Guides > Frame Aspect submenu. The frame aspect is usually set to Default, which forces the frame aspect to the same resolution as the image that’s displayed in the view. However, when the frame aspect is set to a specific value, the guides will conform to the exact boundaries of the specified format and any image area outside of that will be dark gray.

– **To show or hide specific guides:** Right-click in the viewer and then choose an option from the Guides submenu. A variety of specific guides are provided, each of which can be individually enabled and disabled.

  – **Monitor Safety:** Monitor Safety indicates the safe action area viewable on most monitors and TV screens.
  
  – **Safe Title:** Safe Title indicates the safe area for titles viewable on all TV and monitor screens.
  
  – **Center:** Center shows a crosshair for the center point and x- and y-axis of the view.
  
  – **Film:** Some frame formats include film guides preset for you, whereas some will require customization. The film guides can be customized in the Preferences > Frame Format window.

Frame Format Settings

In the Frame Format panel of the Fusion Settings window (available in the Fusion menu), there are two film guide settings that you can use to customize these guides.

– **Guide 1** contains four fields that specify the offset from the edges of the image for the left, top, right, and bottom guides, in that order. As with all offsets in Fusion, this is a resolution-independent number where 1 is the width of the full image and 0.5 is half the width of the image.

– **Guide 2’s text box** is used to set the aspect ratio of the projection area.
Domain of Definition and Region of Interest

As a compositing environment, the Fusion page uses the standard compositing conventions of Region of Interest (RoI) and Domain of Definition (DoD) to dramatically improve performance.

Domain of Definition (DoD)

In compositing, the Domain of Definition, frequently abbreviated to DoD, refers to a rectangular region that defines what part of an image actually contains data. DoD makes the concept of an image’s actual frame somewhat flexible, since rendering is no longer limited to the actual width and height of the image. This has two effects on the way Fusion renders images.

Firstly, nodes will no longer be required to render portions of the image that will not be affected by the node. This helps the renderer to optimize its performance. Secondly, Fusion can now keep track of and apply a node’s effect to pixels that lie outside the visible portion of the image.

For example, consider the output of a Text+ node rendered against a transparent background. The text occupies only a portion of the pixels in the image. Without Domain of Definition, you would be required to process every pixel in the image needlessly. With a DoD, you are able to optimize effects applied to the image, producing faster results and consuming less memory in the process.

The following image shows an image with the DoD outlined.

For the most part, the DoD is calculated automatically and without the need for manual intervention. For example, all the nodes in the Generator category automatically generate the correct DoD. For nodes like Fast Noise, Mandelbrot, and Background, this is usually the full dimensions of the image. In the case of Text+ and virtually all of the Mask nodes, the DoD will often be much smaller or larger.

The OpenEXR format is capable of storing the data window of the image, and Fusion will apply this as the DoD when loading such an image through a Loader node and will write out the DoD through the Saver node.
When using the Fusion page in DaVinci Resolve, clips from the Edit page timeline or Media Pool will typically have the DoD default to the full image width of the source media. The exception is media stored in OpenEXR format.

The DoD is established as soon as the image is created or loaded into the composition. From there, it passes downstream, where viewers combine it with their Region of Interest in order to determine exactly what pixels should be affected by the node. As you work, different nodes will automatically shrink, expand, or move the DoD as they apply their effect to an image, causing the DoD to change from node to node.

### Showing the DoD

If the current DoD for a node is different from the frame size of that image, it’s shown in the tooltip that appears when the pointer hovers over a node in the Node Editor. The DoD is also visible in the viewer when you right-click in a viewer and choose Region > Show DoD from the contextual menu.

### Setting the DoD Manually in the Node Editor

It is also possible to set the DoD for an image manually using the Tools > Miscellaneous > Auto Domain node in the Effects Library. This node can be useful when dealing with pre-created media that does not occupy the full image dimensions. For example, a rendering of a 3D character that walks toward the camera will frequently occupy only a portion of the image. The Auto Domain node can be used to animate a DoD that covers the character and ignores the rest of the image, making image processing more efficient.

### Region of Interest (RoI)

The Region of Interest, frequently abbreviated to RoI, is a rectangular region similar to the Domain of Definition. However, unlike the DoD, which tells the node what pixels are actually present in the image, the RoI tells the node which pixels actually need to be rendered. When a node renders, it intersects the current RoI with the current DoD to determine what pixels should be affected.

### Enabling RoI Controls

You can turn on the RoI controls to restrict rendering to a small region of the image to significantly improve performance when you’re only working on a small part of a high-resolution or complex composition. For example, if you’re using paint to clean up some holes in a matte on the floor of a composition with many, many high-resolution layers, 3D, and Lighting operations, you can use the RoI controls to isolate the part of the floor you’re working on, which makes caching that part of the composition much faster.

**To enable the RoI controls, do one of the following:**

- Click the RoI button in the 2D Viewer toolbar.
- Right-click in a viewer and choose Region > Show DoD from the contextual menu.

When RoI is enabled and Show is selected from the menu, a rectangular RoI control appears in the viewer. If this is the first time RoI has been enabled, it will be set to the full width and height of the image. Otherwise, the last known position of the RoI for that view is used. However, if you want to set the RoI to a custom area within the frame, you can do one of the following.

**To adjust the RoI controls, do one of the following:**

- Drag any edge of the RoI rectangle to adjust one side of the RoI.
- Drag a corner to adjust the size of the RoI rectangle from that corner.
- Drag the small circle found at the top left corner of the RoI rectangle to move the RoI without adjusting its dimensions.

Sometimes, it’s faster to simply draw a rectangle where you want the RoI to be.
To quickly draw the RoI at the desired size:

1. Choose Set from the viewer menu next to the RoI button, or right-click anywhere within the viewer and choose Region > Set Region.

2. When the pointer turns into an RoI drawing cursor, drag within the viewer to set a RoI rectangle.

Alternatively, an Auto command sets the RoI to fit whichever pixels are visible at the current zoom/pan level in the viewer. This lets you quickly limit the RoI to whatever part of the composition you’ve zoomed into.

To automatically draw the RoI:

- Choose Auto from the viewer menu next to the RoI button.
- Right-click anywhere within the viewer and choose Region > Auto Region.

When you no longer need to use the RoI, you can reset it.

To reset the RoI to the full width and height of the current image, do one of the following:

- Choose Reset from the viewer menu next to the RoI button.
- Right-click anywhere within the viewer and choose Region > Reset Region from the contextual menu or from the toolbar button menu.
- Disable the ROI control, which will also reset it.

While the RoI Is Active

The RoI is only used for previewing your composition while you work, not for output from Fusion. While the RoI is active, Fusion will only request rendering of the pixels inside the region when it displays an image in that viewer. Flipbook Previews that you create in that viewer will also respect the current RoI.

MediaOut and Saver nodes will always use the full image dimensions when writing the image to disk, ignoring any RoI you’ve set in the viewers.

The RoI improves not only rendering speed and memory use, but it can also reduce file I/O, since Loaders and Medialn nodes only load pixels from within the RoI, if one is specified. This does require that the file format used supports direct pixel access. Cineon, DPX, and many uncompressed file formats support this feature, as well as OpenEXR and TIFF in limited cases.

Please note that changes to the viewed image size or color depth will cause the pixels outside the RoI to be reset to the image’s canvas color. This also happens when switching in and out of Proxy mode, as well as during Proxy mode switching with Auto Proxy enabled. When the image size is maintained, so are the last rendered pixel values outside the RoI. This can be useful for comparing changes made within the RoI with a previous node state.

**TIP:** Right-clicking in a viewer and choosing Options > Show Controls for showing onscreen controls will override the RoI, forcing renders of pixels for the entire image.

Managing Viewer Lookup Tables (LUTs)

Lookup Tables, or LUTs, can be used to help match the appearance of a viewer to its eventual output destination. They’re essentially image-processing operations that affect only the image being previewed in the viewer, not the image data itself. There are two basic ways that LUTs can calculate color transformations: The first is a simple 1D LUT, and the second is a more sophisticated 3D LUT.
The simplest form of a LUT is a 1D LUT. It accounts for one color channel at a time, so it can make overall tonality changes but not very specific color changes.

A 3D LUT looks at each possible color value (red, green, and blue) independently. A 3D LUT allows for large global changes as well as very specific color changes to be applied to images very quickly.

How Lookup Tables Work in Fusion

A Lookup Table (LUT) is a table of values used to transform the color and luminance of an image. A 1D LUT uses a two-column table for input color and output color, while a 3D LUT uses more of a matrix. A LUT is used primarily to correct for variances in the monitor or the source color space of the image. You can choose to apply a LUT to all the viewers or apply different LUTs to each viewer.

Image LUTs

Image LUTs can be applied to each viewer. In fact, you can even apply separate Image LUTs for the A and B buffers of a single viewer. These LUTs can only be applied to 2D images and not to 3D scenes. Image LUTs are routinely used to get from one scene-referred color space to another. For example, if you’re working with log-encoded media but want to see how the image will look in the final color space, you can choose a LUT to make the image transform as a preview.

Buffer LUTs

The Buffer LUT is applied to the viewers regardless of contents, including 3D scenes, 3D materials, and subview types. Only one Buffer LUT can be applied. If a 2D image is being displayed with an Image LUT applied, then the Buffer LUT is applied to the result of the image LUT. Buffer LUTs are typically used to simulate another output color space that’s unique to the display you’re using—for instance, making a DCI-P3 projector show the image as it would look on an sRGB monitor.

To use a Buffer LUT:
1. Disable the LUT button above the viewer.
2. Right-click in the viewer and choose Global Options > Buffer LUT > Enable.
3. Right-click in the viewer and choose Global Options > Buffer LUT > Type of LUT you want to apply.

When dealing with nonlinear files from many of today’s digital cinema cameras, a modern workflow would be to convert everything to linear at the beginning of the node tree, then create your composite, and then apply an Image LUT or Buffer LUT that matches the color space you want it to be in for either grading in the Color page or for final output.

However, in more elaborate production pipelines, you may need to apply multiple LUTs consecutively.

Types of Viewer LUTs

Aside from the industry standard 1D and 3D LUTs, other types of LUTs are supported, including script-based Fuse node LUTs and macros assembled from standard nodes. Generally, LUT processing is performed on the graphics card’s GPU in real time, although the performance of macro-based LUTs is based on the nodes they contain.

Fusion View LUT

The Fusion View LUT is the default and is a frequently used LUT type. It provides an RGBA curve that can be used to assign IN/OUT value pairs. This control is identical to that provided by the Color Curve node.

Since the purpose of the View LUT is to provide an unchanging correction for the monitor or the file’s color space, however, these splines cannot be animated.
Log-Lin View LUT
The Log-Lin LUT converts logarithmic data to linear, and vice versa. This can be particularly useful when used in conjunction with supplied LUT files that expect logarithmic data. It is similar to the Cineon Log node.

Gamut View LUT
The Gamut LUT converts a source color space to an output color space, with options to deal with gamma settings, alpha channels, and premultiplication. The Gamut LUT is a frequently used LUT type to correct the viewer when working with Linear Gamma in the Node editor.

Macro LUTs
Any macro node can also be used as a viewer LUT simply by saving the macro’s .setting file to the correct Fusion directory.

In DaVinci Resolve, LUTs are saved in the following locations:
- On macOS: Macintosh HD/Users/username/Library/Application Support/Blackmagic Design/Fusion/LUTs/
- On Windows: C:\Program Files\Blackmagic Design\Fusion\LUTs
- On Linux: home/username/local/share/DaVinciResolve/Fusion/LUTs

In Fusion Studio, LUTs are saved in the following locations:
- On macOS: Macintosh HD/Users/username/Library/Application Support/Blackmagic Design/Fusion/LUTs/
- On Windows: C:\Users\username\AppData\Roaming\Blackmagic Design\Fusion\LUTs
- On Linux: home/username/fusion/BlackmagicDesign/Fusion/LUTs

For this to work, the macro must have one image input and one image output. Any controls exposed on the macro will be available when the Edit option is selected for the LUT. For more information about creating macros, see Chapter 67, “Node Groups, Macros, and Fusion Templates” in the DaVinci Resolve Reference Manual or Chapter 6 in the Fusion Reference Manual.

LUT Presets
All LUTs available to DaVinci Resolve are also accessible to the Fusion page, which includes custom LUTs you’ve installed, as well as preset LUTs that come installed with DaVinci Resolve, such as the highly useful VFX IO category that includes a wide variety of miscellaneous to Linear and Linear to miscellaneous transforms. All of these LUTs appear by category in the viewer LUT menu.

Fuse LUTs
Fuses are scriptable plug-ins that are installed with the application or that you create in Fusion. A fuse named CT_ViewLUTPlugin can be applied as a LUT to a viewer. You can also script fuses that use graphics hardware shaders embedded into the LUT for real-time processing. Since fuse LUTs require shader-capable graphics hardware, they cannot be applied in software. For more information about Fuses, see the Fusion Scripting Guide located on the Blackmagic Design website.

Using Viewer LUTs
Viewer LUTs can be enabled, edited, and turned off using the viewer LUT button and menu, as well as by using the viewer contextual menu. This menu shows all LUTs available to Fusion, including custom LUTs you’ve installed yourself.
To turn the current viewer LUT on and off:

- Click the LUT button in the viewer toolbar to toggle the viewer LUT on and off.
- The LUT menu can also be found as a submenu in the viewer’s contextual menu.

To choose another viewer LUT:

- Open the menu to the right of the viewer LUT button and choose an option from the viewer LUT menu.

To apply a Buffer LUT:

1. Right-click anywhere within the viewer and choose Global Options > Buffer LUT > Enable.
2. To choose a specific Buffer LUT, right-click again and choose a LUT from the Global Options > Buffer LUT submenu.

Buffer LUTs are often useful for applying monitor corrections, which do not usually change between projects.

To remove a Buffer LUT:

- Right-click anywhere within a viewer and choose Global Options > Buffer LUT > Enable to uncheck it.
Editing Viewer LUTs

The viewers are the primary area where composites are assessed, so it’s crucial that they provide an accurate representation of what the content will look like when it’s played for an audience. The LUT Editor allows you to customize your viewer’s output to match the gamma and color characteristics of your eventual playback device, or to test how the current image looks in a completely different color space, or how it holds up over a range of different color spaces.

**To open any editable viewer LUT option’s Editor:**

1. Click the LUT button in the viewer toolbar to enable it.
2. Do one of the following:
   - Choose Edit from the bottom of the viewer LUT menu.
   - Right-click in the viewer and then choose LUT > Edit from the contextual menu.

Editing the Fusion View Lookup Table

Similarly to the Color Curves node, the Fusion View LUT Editor uses spline-based color correction. In addition to the ability to modify the separate color channels, the LUT has Gain and Gamma sliders. The Gain slider is helpful for temporarily brightening or darkening the viewed image, allowing easier examination of shadow or highlight detail. The Color Gamma and Alpha Gamma sliders are used to duplicate the gamma values of the eventual output device. Video monitors, for example, commonly have a gamma of 1.7, while computer monitors can range anywhere from 1.6 to 2.2. Alpha Gamma is applied only when viewing the alpha channel of an image, or when viewing masks.

The LUT Editor for the default Fusion View LUT

Editing the Gamut View LUT

The Gamut View LUT Editor lets you choose a Source and Output color space to guide the viewer transform.

The Remove and Add Gamma checkboxes let you choose to do the gamut conversion with linear or nonlinear gamma, or they let you simply remove or add the appropriate gamma values without changing the color space.

Selecting the Pre-Divide/Post-Multiply checkbox will cause the image’s pixel values to be divided by the alpha values prior to this conversion, and then re-multiplied by the alpha value after this conversion. This helps to avoid the creation of illegally additive images, particularly around the edges of a blue/green key or when working with 3D rendered objects.
The Gamut View LUT Editor

Editing the Log-Lin LUT

The Log-Lin LUT lets you apply a Log to Lin or Lin to Log operation using the Mode pop-up menu. You can choose the type of log-encoding to process from the Log Type drop-down, and choose whether to lock the R, G, and B channels together. A level adjustment lets you redefine the digital range of values used for the output, while Soft Clip (Knee), Film Stock Gamma, and Conversion Gamma sliders let you further customize the color transform. Lastly, a Conversion Table field and Browse button let you add an additional LUT as part of this operation.

LUT Processing Order

In elaborate workflows, facilities may apply multiple LUTs in a row before the image is seen. The order of these is important since each LUT delivers different outputs. For instance, for a Cineon file in Log color space you may often apply three LUTs. First a Log to Lin conversion, followed by a Fusion View LUT to apply a color calibration, and a third one to correct it for display on an sRGB monitor, or replace the last with a 3D DCP LUT if you are viewing on a projector.

When you select a node to be displayed, the image produced is processed before it is shown in the viewers. The processing order is slightly different for 2D images and 3D scenes.
2D images first have the image LUT applied, and the result is composited over the checker underlay. 3D scenes are instead rendered with OpenGL.

The order of processing for 2D images and 3D scenes

For either 2D or 3D, the result may be drawn to an offscreen buffer where a Buffer LUT can be applied, along with dithering, a full view checker underlay, and any stereo processing. The final result is then drawn to the viewer and any onscreen controls are drawn on top.

Applying Multiple LUTs

The viewer contextual menu can be used to apply multiple image LUTs into a processing chain.

To apply an additional LUT, do the following:
1. Right-click anywhere within the viewer.
2. From the viewer’s contextual menu, choose LUT > Add New.
3. From the Add New submenu, choose a LUT to add.

To remove a LUT other than the first LUT, do the following:
1. Right-click anywhere within the viewer.
2. From the viewer’s contextual menu, choose LUT > Delete.
3. From the Delete submenu, choose a LUT to remove.

A complete stacked LUT configuration can be saved to and loaded from a .viewlut file, as described below.

Saving Custom LUTs

There are a variety of ways to create and use different viewer LUTs in Fusion. You can save LUTs when you save viewer settings, you can import LUTs that have been exported from Fusion or other applications, and you can open any one of the various supported LUT file types. In addition, you can use the standard nodes in Fusion to create macros, which can then be saved and used as a LUT.

LUT Settings

The most straightforward way to save a LUT you have created using the Fusion View LUT Editor is to use the LUT > Save menu found in the viewer contextual menu. The settings are saved as an ASCII file with the extension .viewlut in the LUTs folder. Any files with this extension found in that folder will appear in the Image LUT menus for ease of loading. You can also load the settings that are not found in the menu by choosing LUT > Load from the viewer’s contextual menu.

Using Viewer Settings

If you’ve modified a LUT, choosing Settings > Save New from the viewer’s contextual menu will save all the viewer’s settings, including all LUT curves and gain/gamma values. You can save these under different names, and each settings file can be reloaded at any time by choosing Settings > filename from the viewer’s contextual menu. Choosing Save Default from the same menu will make these settings the standard for all new comps.
Using LUT Curves

The Viewer LUT Edit dialog can be used to import and export LUT curves. You can export the LUT curves as either ASCII or Saved format. The ASCII (.alut) file format is useful for sharing LUT curves with other software, whereas the Saved (.lut) file format is preferred for Fusion, as it is more compact, accurate, and allows further editing.

To export a LUT, do the following:
1. Click the viewer LUT button to enable it.
2. Click the viewer LUT menu, and then choose Edit.
3. Right-click on the LUT Curve Editor, and then choose Export LUT.
4. Select a LUT format at the bottom of the file browser window.
5. Enter a name for the LUT and click Save.

The Import LUT option will load LUT files back into the Curve Editor, or alternatively, if the file has been saved in Fusion’s LUTs folder, it will appear in the LUT drop-down menu list.

**TIP:** This is one way to move LUTs between viewers or to and from the Color Curves node or any other LUT Editor in Fusion.

LUT Files

Any supported LUT files in the LUTs folder can be used by choosing them either from the LUT drop-down menu or the viewer’s contextual menu. This includes 1D and 3D LUTs such as Fusion’s .lut, .alut and .alut3 formats, as well as .cube, .shlut, .look, .3dl, and .itx formats. This is a convenient way to access standard format LUT files for different projects.

Settings and Macros

Since LUTs are a form of color correction, you can also use any node, macro, or group of nodes as a viewer LUT.

To use a node, group, or macro as a viewer LUT, do the following:
1. Select the node, group, or macro.
2. Right-click over the selected node, and then choose Settings > Save As from the menu.
3. In the file browser, go to the LUTs folder as set in Preferences > Global > Path Map > LUTS.
4. Click Save to save the .settings file.

This allows almost any combination of nodes to be used as a viewer LUT. This is the most flexible approach but is also potentially the slowest. The LUT nodes must be rendered solely on the CPU, whereas other methods are GPU-accelerated.

Setting a Default LUT

The default LUT applied when a new composition is created can be assigned in the Viewer panel of the Fusion Settings window. Clicking the Enable Display LUT checkbox allows you to select a LUT from the Display LUT plug-ins list.
**Viewer Preferences and Settings**

The default settings for each viewer can be changed using the Viewer panel in the Preferences. The position and size of each floating viewer can also be saved using the Layout menu in the Preferences.

**Viewer Settings**

It is often preferable to switch between entirely different viewer configurations while working. For example, while keying, the image may be in the main viewer, and the alpha channel may be in a subview. Viewer settings toward the end of a project may consist of the histogram, vectorscope, and waveform, as well as the image in a view set to Quad view.

Fusion provides the ability to quickly load and save viewer settings to help reduce the amount of effort required to change from one configuration to another.

**To save a viewer setting, do the following:**

1. Right-click over the viewer you want to save.
2. From the contextual menu, choose Setting > Save New.
3. Enter a name for the settings and click Save.

**To load a viewer setting, do the following:**

1. Right-click over the viewer you want to load a setting into.
2. From the contextual menu, choose Settings > filename.

**Loading and Saving Defaults for a Viewer**

The viewer can save new defaults and be returned to its defaults using the Load Defaults and the Save Defaults options in the Settings portion of the View contextual menu.
The Viewer Options Menu

The Options menu of the viewer contains several ways you can customize the look and behavior of the viewer. Many of these options are also in the viewer contextual menu.

**Show Controls**
When onscreen controls are not necessary or are getting in the way of evaluating the image, you can temporarily hide them using the Show Controls option. This option is toggled using Command-K.

**Checker Underlay**
The Checker Underlay shows a checkerboard beneath transparent pixels to make it easier to identify transparent areas. This is the default option for 2D viewers. Disabling this option replaces the checkerboard with black.

**Pixel Grid**
Enabling this option will show a light black grid that outlines the exact boundaries of pixels in the image when the image is scaled past a certain threshold. The default is Off.

**Smooth Resize**
The Smooth Resize option uses a smoother bilinear interpolated resizing method when zooming into an image in the viewer. When Smooth Resize is disabled, scaling uses the nearest neighbor method and shows noticeable aliasing artifacts but is more useful for seeing the actual pixels of the viewed image when you zoom all the way down to a pixel level since there is no interpolation. This option is enabled by default and can be toggled by clicking on the SmR button in the viewer toolbar.

**Show Square Pixels**
Depending on the frame format preferences and the type of footage loaded, many images may have pixels that are rectangular instead of square. Both the NTSC and PAL video standards, as well as some anamorphic film formats, use rectangular pixels. A computer monitor uses perfectly square pixels. To compensate for this, aspect correction is automatically performed when viewing non-square pixels. This prevents non-square pixel images from appearing squashed or stretched in the viewer.

You can enable the Show Square Pixels option to override the aspect correction. Show Square Pixels can also be toggled on and off using the 1:1 button in the viewer toolbar.

**Gain/Gamma**
Exposes or hides a simple pair of Gain and Gamma sliders that let you adjust the viewed image. Especially useful for "gamma slamming" a composite to see how well it holds up with a variety of gamma settings. Defaults to no change.

**360° View**
Sets the Fusion page viewer to properly display spherical imagery in a variety of formats, selectable from this submenu. Disable toggles 360 viewing on or off, while Auto, LatLong, Vert Cross, Horiz Cross, Vert Strip, and Horiz Strip let you properly display different formats of 360° video.

**Locking the Viewer (Command-L)**
You can lock a viewer to prevent it from updating. The node that’s loaded into that viewer still processes and the new image is queued for display in the viewer, but until you unlock it, the viewer does not update. By default, the viewer is unlocked.
Additional Viewer Options

There are additional commands when you right-click anywhere within a viewer and choose from the generically named Options submenu.

**Alpha Overlay**
When you enable the alpha overlay, the viewer will show the alpha channel overlaid on top of the color channels. This can be helpful when trying to see where one image stops and another begins in a composite. This option is disabled by default.

**Overlay Color**
When you turn the alpha overlay on, the default color is to show white for the area the alpha covers. There are times when white does not show clearly enough, depending on the colors in the image. You can change the color by choosing a color from the list of Overlay Color options.

**Follow Active**
Enabling the Follow Active option will cause the viewer to always display the currently active node in the Node Editor. This option is disabled by default, so you can view a different node than what you control in the Control Panel.

**Show Controls**
When onscreen controls are not necessary or are getting in the way of evaluating the image, you can temporarily hide them using the Show Controls option. This option is toggled using Command-K.

**Show Full Color Range**
When working with floating-point images, you will occasionally need to visualize the values that fall outside the normal luminance range. Enabling the Show Full Color Range option using the toolbar button automatically normalize any image displayed in the viewer. Normalization causes the brightest pixel in a color channel to be mapped to a value of 1.0 (white) and the darkest pixel to be mapped to a value of 0.0 (black). Midrange values are scaled appropriately to fit within that range. It is also useful when viewing Z-buffer or other auxiliary channels, which often use value ranges far different from those in the color channels.

**Show Labels**
The Show Labels option lets you toggle the display of the text that sometimes accompanies onscreen controls in the viewer without disabling the functions that are showing those overlays, and without hiding the onscreen controls themselves.

**Status Bar Information**
The status bar at the bottom of the Fusion window provides the exact RGBA and Z values for the pixel beneath the pointer when it’s hovering within one of the viewers. Additional information about the X and Y coordinates of the cursor and the exact pixel position are also displayed.

The status bar showing coordinates and color information
Chapter 69

Editing Parameters in the Inspector

The Inspector is where you adjust the parameters of each node to do what needs to be done. This chapter covers the various node parameters and methods for working with the available controls.

Contents

- Overview of the Inspector 1189
- The Tools and Modifiers Panels 1190
- Customizing the Inspector 1190
- Inspector Height 1190
- Inspector Display Preferences 1191
- Opening Nodes in the Inspector 1191
- Pinning Multiple Nodes in the Inspector 1192
- Hiding Inspector Controls 1193
- Using the Inspector Header 1193
- Selecting and Viewing Nodes in the Inspector 1194
- Using Header Controls 1194
- Versioning Nodes 1195
- Parameter Tabs 1195
- The Settings Tab 1195
- Inspector Controls Explained 1199
- Fusion Slider Controls 1199
- Thumbwheel 1200
- Range Controls 1200
- Checkboxes 1200
Overview of the Inspector

While the creation and connection of nodes in the Node Editor determines the tools and order of operations that make up a composition, the Inspector (previously called the Control Panel) is where you adjust the various parameters inside each node to do what needs to be done.

Inspector displays the Brightness Contrast controls
This chapter covers methods for opening node parameters in the Inspector to edit them in different ways according to the type of available controls.

**To display the Inspector:**
- Click the Inspector button on the UI toolbar.

**The Tools and Modifiers Panels**
The Inspector is divided into two overall panels.
- The Tools panel is where the parameters of selected nodes appear so you can edit them.
- The Modifiers panel is where you edit optional extensions to the tool's standard toolset as well as automated expressions that you can attach to individual parameters to create animated effects. Additionally, certain nodes such as the Paint node generate data such as Strokes, which are saved in the Modifiers panel.

![Modifiers displayed in the Modifiers panel](image)

**Customizing the Inspector**
You can customize how the Inspector is presented in a variety of ways.

**Inspector Height**
A small arrow button at the far right of the UI toolbar lets you toggle the Inspector between full-height and half-height views, depending on how much room you need for editing parameters.

![The Maximize button on the left side of the Inspector](image)

In maximized height mode, the Inspector takes up the entire right side of the UI, letting you see every control that a node has available, or creating enough room to see the parameters of two or three pinned nodes all at once. In half-height mode, the top of the Inspector is aligned with the tops of the viewers, expanding the horizontal space that’s available for the Node Editor.
Inspector Display Preferences

By default, you see only selected nodes in the Inspector, and only the Active node is expanded to show its controls. You can change this behavior by choosing Fusion > Fusion Settings in the Fusion page or File > Preferences in Fusion Studio and opening the User Interface panel. In the User Interface, checkboxes manage the display of controls.

- **Auto Control Open**: When enabled (the default), whichever node is active automatically opens its controls in the Inspector. When disabled, selecting an active node opens that node’s Inspector header in the Inspector, but the parameters remain hidden unless you click the Inspector header.

- **Auto Control Hide**: When enabled (the default), only selected nodes are visible in the Inspector, and all deselected nodes are automatically removed from the Inspector to reduce clutter. When disabled, parameters from selected nodes remain in the Inspector, even when those nodes are deselected, so that the Inspector accumulates the parameters of every node you select over time.

- **Auto Control Close Tools**: When enabled (the default), only the parameters for the active node can be exposed. When disabled, you can open the parameters of multiple nodes in the Inspector if you want.

- **Auto Controls for Selected**: When enabled (the default), selecting multiple nodes opens multiple control headers for those nodes in the Inspector. When disabled, only the active node appears in the Inspector; multi-selected nodes highlighted in white do not appear.

Opening Nodes in the Inspector

Before you can edit a node’s parameters, you need to open it in the Inspector.

**To display a node’s controls in the Inspector:**

- Select one or more nodes from the Node Editor, Keyframes Editor, or Spline Editor.

When you select a single node so that it’s highlighted orange in the Node Editor, all of its parameters appear in the Inspector. If you select multiple nodes at once, Inspector headers appear for each selected node (highlighted in white in the Node Editor), but the parameters for the active node (highlighted in orange) are exposed for editing.
Opening multiple nodes in the Inspector

Only one node’s parameters can be edited at a time, so clicking another node’s Inspector header opens that node's parameters and closes the parameters of the previous node you were working on. This also makes the newly opened node the active node, highlighting it orange in the Inspector.

**Pinning Multiple Nodes in the Inspector**

For instances where you need to work quickly by editing the parameters of multiple nodes at the same time, you can use the Pin button in the Inspector header of nodes in the Inspector to keep those parameters exposed in the Inspector, regardless of whether that node is selected and active.

While the Pin button is on, that node’s parameters remain open in the Inspector. If you select another node in the Node Editor, that node’s parameters appear beneath any pinned nodes.
A pinned node on the bottom, with a selected node at the top

You can have as many pinned nodes in the Inspector as you like, but the more you have, the more likely you’ll need to scroll up or down in the Inspector to get to all the parameters you want to edit. To remove a pinned node from the Inspector, just turn off its Pin button in the Inspector header.

**Hiding Inspector Controls**

If you like, Inspector parameters for specific nodes can be hidden so they never appear, even when that node is selected. This can be useful for preventing accidental changes by you or other compositors who may be working on a composition in situations where you don’t want to lock the node.

**To Toggle the Inspector controls for a node or off:**

– Right-click on the node in the Node Editor, or on the Inspector header, and choose Modes > Show Controls from the contextual menu.

**Using the Inspector Header**

When you select a node, it populates the Inspector with a title bar, or Inspector header, that displays that node’s name as well as other controls that govern that node. A node’s Inspector header itself has a variety of controls, but clicking (or double-clicking) on an Inspector header also exposes that node’s parameters.
When you select multiple nodes at once, you’ll see multiple headers in the Inspector. By default, only the parameters for the active node (highlighted orange in the Node Editor) can be opened at any given time, although you can change this behavior in Fusion’s Preferences.

**Selecting and Viewing Nodes in the Inspector**

Inspector headers are click targets for selecting nodes, opening and closing node parameters, and other things.

**Methods of using headers:**

- **To select a node using the Inspector header:** When multiple nodes are selected, you can make a node the active node by clicking its Inspector header in the Inspector. As the actively selected node, the Inspector header and the corresponding node in the Node Editor are highlighted orange, and its parameters are exposed.

- **To load a node into the viewer using the Inspector header:** You can view a node by dragging its header into one of the viewers.

- **To view a node’s splines with the control header:** If you want to view the animated curves of a node in the Spline Editor, you can add them by dragging the Inspector header into the Spline Editor. All animated splines for the parameters of that node will automatically be displayed.

**Using Header Controls**

The controls found in each node’s Inspector header make it fast to do simple things.

- **To turn nodes off and on:** Each Inspector header has a toggle switch to the left of its name, which can be used to enable or disable that node. Disabled nodes pass image data from the previous upstream node to the next downstream node without alteration.

- **To change the Inspector header name:** The name of the node corresponding to that Inspector header is displayed next. You can change the name by right-clicking the Inspector header to expose contextual menu commands similar to those found when you right-click a node in the Node Editor and choosing Rename. Alternatively, you can click an Inspector header and press F2 to edit its name. A Rename dialog appears, where you can enter a new name and click OK (or press Return).

- **To color-code nodes:** A color pop-up menu lets you color code with one of 16 colors. Choose Clear Color if you want to return that node to the default color.

- **To version nodes:** Turning on the Versions button displays a Version bar with six buttons. Versioning is described in the following section.

- **To pin Inspector controls:** Clicking the Pin button “pins” that node’s parameters in the Inspector so they remain in place, even if you deselect that node. You can have as many pinned nodes as you like in the Inspector, but the more you have, the more likely you’ll be scrolling up and down the Inspector to navigate all the available parameters.

- **To lock nodes:** Clicking the Lock button locks that node so no changes can be made to it.

- **To reset Inspector controls:** The rightmost button in the Inspector header is a Reset button that resets the entire node to the default settings for that node.
Versioning Nodes

Each button is capable of containing separate parameter settings for that node, making it easy to save and compare up to six different versions of settings for each node. All versions are saved along with the node in the Node Editor for future use.

An orange underline indicates the currently selected version, which is the version that’s currently being used by your composition. To clear a version you don’t want to use any more, right-click that version number and choose Clear from the contextual menu.

Parameter Tabs

Underneath the Inspector header is a series of panel tabs, displayed as thematic icons. Clicking one of these icons opens a separate tab of parameters, which are usually grouped by function. Simple nodes, such as the Blur node, consist of two tabs where the first contains all of the parameters relating to blurring the image, and the second is the Settings tab.

More complicated nodes have more tabs containing more groups of parameters. For example, the Delta Keyer has seven tabs: separating Key, Pre-Matte, Matte, Fringe, Tuning, and Mask parameters, along with the obligatory Settings tab. These tabs keep the Delta Keyer from being a giant scrolling list of settings and make it easy to keep track of which part of the keying process you’re finessing as you work.

The Settings Tab

Every node that comes with Fusion has a Settings tab. This tab includes a set of standard controls that appear for nearly every node, although some nodes have special Settings tab controls that others lack.
The following controls are common to most nodes, although some are node-specific. For example, Motion Blur settings have no purpose in a Color Space node.

**Blend**

The Blend control is found in all nodes, except the Loader, Medialain, and Generator nodes. It is used to blend between the node’s unaltered image input and the node’s final processed output. When the blend value is 0.0, the outgoing image is identical to the incoming image. Ordinarily, this will cause the node to skip processing entirely, copying the input straight to the output. The default for this node is 1.0, meaning the node will output the modified image 100%.

**Process When Blend is 0.0**

This checkbox forces the node to process even when the input value is zero and the image output is identical to the image input. This can be useful on certain nodes or third-party plug-ins that store values from one frame to the next. If this checkbox is disabled on nodes that operate in this manner, the node will skip being processed when the Blend is set to 0, producing incorrect results on subsequent frames.

**Red/Green/Blue/Alpha Channel Checkboxes**

Most nodes have a set of RGBA checkboxes in the Settings tab. These checkboxes let you exclude any combination of these channels from being affected by that node.
For example, if you wanted to use the Transform node to affect only the green channel of an image, you can turn off the Red, Blue, and Alpha checkboxes. As a result, the green channel is processed by this operation, and the red, blue, and alpha channels are copied straight from the node’s input to the node’s output, skipping that node’s processing to remain unaffected.

![Transforming only the green color channel of the image with a Transform effect](image)

**Skipping Channel Processing**

Under the hood, most nodes actually process all channels first, but afterward copy the input image to the output for channels that have been unchecked. Modern workstations are so fast that this isn’t usually noticeable, but there are some nodes where deselecting a channel actually causes that node to skip processing that channel entirely. Nodes that operate this way have a linked set of Red, Green, Blue, and Alpha checkboxes on another tab in the node.

![Channel checkboxes on the Controls tab of the Blur node indicate that disabled channels won’t be processed at all, to save rendering time.](image)

In these cases, the Common Control channel checkboxes are instanced to the channel boxes found elsewhere in the node. Blur, Brightness/Contrast, Erode/Dilate, and Filter are examples of nodes that all have RGBY checkboxes in the main Controls tab of the Inspector, in addition to the Settings tab.

**Apply Mask Inverted**

When the Apply Mask Inverted checkbox is enabled, masks attached to the Effect Mask input of that node are inverted.

![TIP: The Apply Mask Inverted checkbox option operates only on effects masks, not on garbage masks.](image)
Multiply By Mask
Selecting this option will cause the RGB values of the masked image to be multiplied by the Mask channel’s values. This will cause all pixels of the image not included in the mask (i.e., those set to 0) to become black. This creates a premultiplied image.

Use Object/Use Material (For Masking)
Some 3D animation and rendering software can output to file formats that support auxiliary channels. Notably, the OpenEXR file format supports Object ID and Material ID channels, either of which can be used as a mask for an effect. This checkbox determines whether the channels will be used if they are available. The specific Material ID or Object ID affected is chosen using the next set of controls.

Pick Controls
The Pick Controls are only displayed once the Use Object or Use Material checkbox is enabled. These controls select which ID is used to create a mask from the Object or Material channels saved in the image. You use the Pick button to grab IDs from the image in the viewer, the same way you use the Color Picker to select a color. The image or sequence must have been rendered from a 3D software package with those channels included.

Correct Edges
The Correct Edges checkbox is only displayed once the Use Object or Use Material checkbox is enabled. When the Correct Edges checkbox is enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. When disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

Motion Blur
For nodes that are capable of introducing motion, such as Transform nodes, Warp nodes, and so on, the Motion Blur checkbox toggles the rendering of motion blur on or off for that node. When this checkbox is enabled, the node’s predicted motion is used to produce the blur caused by a virtual camera shutter. When the control is disabled, no motion blur is created.

When Motion Blur is disabled, no additional controls are displayed. However, turning on Motion Blur reveals four additional sliders with which you can customize the look of the motion blur you’re adding to that node.

Quality
Quality determines the number of samples used to create the blur. The default quality setting of 2 will create two samples on either side of an object’s actual motion. Larger values produce smoother results but will increase the render time.

Shutter Angle
Shutter Angle controls the angle of the virtual shutter used to produce the Motion Blur effect. Larger angles create more blur but increase the render times. A value of 360 is the equivalent of having the shutter open for one whole frame exposure. Higher values are possible and can be used to create interesting effects. The default value for this slider is 100.

Center Bias
Center Bias modifies the position of the center of the motion blur. Adjusting the value allows for the creation of trail-type effects.

Sample Spread
Adjusting Sample Spread modifies the weight given to each sample. This affects the brightness of the samples set with the Quality slider.
Scripting
Scripting fields are present on every node and contain one or more editable text fields that can be used to add scripts that process when that node is rendering. For more information on the contents of this tab, please consult the Scripting documentation.

Comments
A Comments field is found on every node and contains a single text field that is used to add comments and notes to that node. To enter text, simply click within the field to place a cursor, and begin typing.

When a note is added to a node, the comments icon appears in the Control Header and can be seen in a node’s tooltip when the cursor is placed over the node in the Node Editor. The contents of the Comments tab can be animated over time, if required.

Additional controls appear under this tab if the node is a Loader. For more information, see Chapter 104, “Generator Nodes” In the DaVinci Resolve Reference Manual or Chapter 43 in the Fusion Reference Manual.

Inspector Controls Explained

Although a few nodes use fully customized interface elements that are unique to only that node, the vast majority of nodes use a mix of sliders, angle wheels, and checkboxes. This section explains how to use these controls.

Fusion Slider Controls
Slider Controls are used to select a single value from a range of values. You change the value by dragging the slider or entering a value into the edit box. This is fairly standard behavior for sliders. However, there is additional functionality that can increase your productivity when making changes with sliders.

Clicking on the gutter to the left or right of the handle will increase or decrease the value. Holding Command while clicking on the gutter will adjust the values in smaller increments. Holding Shift while clicking will adjust the value in larger increments.

Hold Command while clicking in the gutter to move in smaller increments

Once you click directly on a slider handle, you can make changes to its value using the Left and Right Arrow keys. The Command and Shift keys can again be used to modify the value in larger or smaller increments.

While slider controls use a minimum and maximum value range, entering a value in the edit box outside that range will often expand the range of the slider to accommodate the new value. For example, it is possible to enter 500 in a Blur Size control, even though the Blur Size sliders default maximum value is 100. The slider will automatically adjust its maximum displayed value to allow entry of these larger values.

If the slider has been altered from its default value, a small circular indicator will appear below the gutter. Clicking on this circle will reset the slider to its default.
**Thumbwheel**

A Thumbwheel control is identical to a slider except it does not have a maximum or minimum value. To make an adjustment, you drag the center portion left or right or enter a value directly into the edit box. Thumbwheel controls are typically used on angle parameters, although they do have other uses as well.

![Thumbwheel controls for X, Y, and Z rotation with arrows on either end for fine-tuning adjustments](image)

You can use the arrowheads at either end of the control to fine-tune your adjustments. Once the thumbwheel has been selected either by dragging or using the arrow keys, you can use the Left and Right Arrows on your keyboard to further adjust the values. As with the slider control, the Command and Shift keys can be used to increase or decrease the change in value in smaller or larger increments.

If the thumbwheel has been altered from its default value, a small circular indicator will appear below above the thumbwheel. Clicking on this circle will reset the thumbwheel to its default.

**Range Controls**

The Range controls are actually two separate controls, one for setting the Low Range value and one for the High Range value. To adjust the values, drag the handles on either end of the Range bar. To slide the high and low values of the range simultaneously, drag from the center of the Range bar. You can also expand or contract the range symmetrically by holding Command and dragging either end of the Range bar. You find Range controls on parameters that require a high and low threshold, like the Matte Control, Chroma Keyer, and Ultra Keyer nodes.

![A Matte Threshold Range control](image)

**TIP:** You can enter floating-point values in the Range controls by typing the values in using the Low and High numeric entry boxes.

**Checkboxes**

Checkboxes are controls that have either an On or Off value. Clicking on the checkbox control will toggle the state between selected and not selected. Checkboxes can be animated, with a value of 0 for Off and a value of 1.0 or greater for On.

![Checkboxes used to select options for tracking](image)
Drop-Down Menus

Drop-down menus are used to select one option from a menu. Once the menu is open, choosing one of the items will select that entry. When the menu is closed, the selection is displayed in the Inspector.

Drop-down menu in the TimeSpeed node

Drop-down menu selections can be animated, with a value of 0 representing the first item in the list, 1 representing the second, and so forth.

Button Arrays

Button arrays are groups of buttons that allow you to select from a range of options. They are almost identical in function to drop-down menu controls, except that in the case of a button array it is possible to see all of the available options at a glance. Often button arrays use icons to make the options more immediately comprehensible.

The Lens Type button array in the Defocus node

Color Chooser and Picker

The Color panel is displayed wherever a parameter requires a color as its value, such as the Fill or Outline color in the Text+ node. The selected color is shown in a swatch with an Eyedropper to its right, and below the swatch is the Color Chooser.

The Color panel with transparency preview

The Color panel is extremely flexible and has four different techniques for selecting and displaying colors.

**TIP:** Color can be represented by 0–1, 0.255, or 0–65000 by setting the range you want in the Preferences > General panel.

macOS and Windows Color Nodes

Clicking on the color swatch will display the operating system’s standard Color Selection node.
Each operating system has a slightly different layout, but the general idea is the same. You can choose a color from the swatches provided—the color wheel on macOS, or the color palette on Windows. However you choose your color, you must click OK for the selection to be applied.

The Color Chooser
You also have access to the built-in color chooser, which includes sections for choosing grayscale values, as well as the currently chosen hue with different ranges of saturation and value. A hue bar and alpha bar (depending on the node) let you choose different values.

Picking Colors from an Image
If you are trying to match the color from an image in the viewer, you can hold down the cursor over the Eyedropper, and then drag the pointer into the viewer. The pointer will change to an Eyedropper, and a pop-up swatch will appear above the cursor with the color you are hovering over and its values. When you are over the color you want, release the mouse button to set the color.
The Color Picker normally selects from a single pixel in the image, but you can adjust the size of the selection by dragging into the viewer with the Eyedropper, and then holding Command and dragging out a rectangle for the sample size you want. The size change applies to all Color Pickers until the size is changed again.

**Gradients**

The Gradient Control bar is used to create a gradual blend between colors. The Gradient bar displays a preview of the colors used from start to end. By default, there are two triangular color stops: one on the left that determines the start color, and one on the right that determines the end color.

The default Gradient controls

**Gradient Type**

The Gradient Type button array is used to select the form used to draw the gradient. Linear draws the gradient along a straight line from the starting color stop to the ending color stop.

Linear gradient

Reflect draws the gradient by mirroring the linear gradient on either side of the starting point.

Reflect gradient

Square draws the gradient by using a square pattern when the starting point is at the center of the image.

Square gradient
Cross draws the gradient using a cross pattern when the starting point is at the center of the image.

Cross gradient

Radial draws the gradient in a circular pattern when the starting point is at the center of the image.

Radial gradient

Angle draws the gradient in a counter-clockwise sweep when the starting point is at the center of the image.

Angle gradient

**Start and End Position**

The Start and End Position controls have a set of X and Y edit boxes that are useful for fine-tuning the start and end position of the gradient. The position settings are also represented by two crosshair onscreen controls in the viewer, which may be more practical for initial positioning.

**Gradient Colors Bar**

The Gradient Colors bar is used to select the blending colors for the gradient. The default two color stops set the start and end colors. You can change the colors used in the gradient by selecting the color stop, and then using the Eyedropper or color wheel to set the new color.

You can add, move, copy, and delete colors from the gradient using the Colors bar.

**To add a color stop to the Gradient Colors bar:**

1. Click anywhere along the bottom of the Gradient Colors bar.

2. Use the Eyedropper or color wheel to set the color for the color stop.

**To move a color stop on the Colors bar:**

– Drag a color stop left or right along the Gradient Color bar.

**To copy a color stop on the Colors bar:**

– Hold Command while you drag a color stop.
To delete a color stop from the Colors bar, do one of the following:

– Drag the color stop up past the Gradient Colors bar.
– Select the color stop, then click the red X button to delete it.

**Interpolation Space**

The Gradient Interpolation Method pop-up menu lets you select what color space is used to calculate the colors between color stops.

**Offset**

When you adjust the Offset control, the position of the gradient is moved relative to the start and end markers. This control is most useful when used in conjunction with the repeat and ping-pong modes described below.

**Once/Repeat/Ping-Pong**

These three buttons are used to set the behavior of the gradient when the Offset control scrolls the gradient past its start and end positions. The Once button is the default behavior, which keeps the color continuous for offset. Repeat loops around to the start color when the offset goes beyond the end color. Ping-pong repeats the color pattern in reverse.

**1x1, 2x2, 3x3, 4x4, 5x5**

These buttons control the amount of sub-pixel precision used when the edges of the gradient become visible in Repeat mode, or when the gradient is animated. Higher settings will take significantly longer to render but will be more precise.

**Gradient Contextual Menu**

Gradients have their own contextual menu that you can bring up by right-clicking on the Gradient bar. In the Gradient contextual menu are options for animating, publishing, and connecting one gradient to another. There is also a gradient-specific modifier that builds a custom gradient by sampling colors from the output of a node in the Node Editor.

**Modifiers**

Modifiers are expressions, calculations, trackers, paths, and other mathematical components that you attach to a parameter to extend its functionality. When a modifier is attached to a parameter, its controls will appear separately in the Inspector Modifiers tab.

**To attach a modifier:**

1. Right-click over the parameter to which you want to attach a modifier.
2. Make a selection from the Modifier submenu in the contextual menu.

**Animating Parameters in the Inspector**

Fusion can keyframe most parameters in most nodes, in order to create animated effects such as animated transforms, rotoscoping with splines, dynamically altering warping behaviors, and so on; the list is endless. For convenience, a set of keyframing controls are available within the Inspector next to each keyframable parameter. These controls are:

– A gray Keyframe button to the right each keyframable parameter. Clicking this gray button creates a keyframe at the current position of the playhead, and turns the button orange.

– When you add a keyframe to a parameter, moving to a new frame and changing the parameter will automatically add a keyframe at the current position.
Whenever the playhead is sitting right on top of a keyframe, this button turns orange. Clicking an orange Keyframe button deletes the keyframe at that frame and turns the button gray again.

Small navigation arrows appear to the right and left if there are more keyframes in those directions. Clicking on navigation arrows to the right and left of keyframes jumps the playhead to those keyframes.

Orange Keyframe buttons in the Inspector show there’s a keyframe at that frame

Once you’ve keyframed one or more parameters, the node containing the parameters you keyframed displays a Keyframe badge, to show that node has been animated.

A keyframed node displays a Keyframe badge in the Node Editor

Once you’ve started keyframing node parameters, you can edit their timing in the Keyframes Editor and/or Spline Editor. For more information about keyframing in Fusion, see Chapter 70, “Animating in Fusion’s Keyframe Editor” in the DaVinci Resolve Reference Manual or Chapter 9 in the Fusion Reference Manual.

**Removing Animation From a Parameter**

**To remove all keyframes from a parameter:**

1. Right-click over the name of the keyframed parameter in the Inspector.
2. Choose Remove “node name:parameter name” from the contextual menu.

**TIP:** If you change the default spline type from Bézier, the contextual menu will display the name of the current spline type.

**Attaching a Parameter to an Existing Animation Curve**

Multiple parameters can be connected to the same animation curve. This can be an invaluable timesaver if you are identically animating different parameters in a node.

To connect a second parameter to the same animation curve:

1. Right-click on the second parameter you want to attach.
2. In the contextual menu, hover over the Connect To submenu.
3. In the Connect To submenu, choose the name of the animated parameter.
**Connecting Parameters**

It is often useful to connect two parameters together even without an animation curve. There are two methods you can use.

**Connecting Parameters by Publishing**

If you want to tie two parameters together so adjusting one adjusts the other, you must connect them together using the Publish menu command on the first parameter and the Connect menu command on the second parameter.

**To Publish and Connect parameters:**

1. Right-click the name of the parameter you want to publish, and choose Publish from the contextual menu.
2. Right-click on the second parameter you want to attach, and choose the name of the parameter you just published from the Connect To submenu.

![The Publish contextual menu](image1)

**Connecting Parameters by Pick Whipping**

You can also use simple expressions to link two parameters together. By using simple expressions via pick whipping, values can be connected and combined visually without the need to publish a value first. The pick whip is a temporary line drawn from one parameter to another in order to create a link between the two.

**To link two parameters using a pick whip:**

1. Double-click the field of a parameter you want to pick whip to another parameter, type =, and then press the Return key.
2. When Pick Whip controls appear underneath the parameter, drag a “whip” from the Add button to the target parameter.

Now, adjusting the target parameter automatically adjusts the original parameter.

![Pick whipping one parameter to another](image2)

**Tip:** Disabling the Auto Control Close node’s General preference, and then selecting two nodes in the Node Editor will allow you to pick whip two parameters from different nodes.
The Expression field can further be used to add mathematical formulas to the value received from the target parameter.


**Contextual Menus**

There are two types of contextual menus you can invoke within the Inspector.

**Node Contextual Menus**

To display the Node Context menu from the Inspector, right-click on the Inspector header. The node’s contextual menu includes the same menu options that are accessed by right-clicking on a node in the Node Editor. See Chapter 66, “Working in the Node Editor,” in the DaVinci Resolve Reference Manual or Chapter 5 in the Fusion Reference Manual for more information on these options.

**Parameter Contextual Menus**

The contextual menu for individual parameters is accessed by right-clicking over the parameter’s name, slider, thumbwheel, range control, button array, or other control type. For example, right-clicking on a slider will provide the slider’s contextual menu, with options to animate the control or add additional modifiers. Many of these options were described in this chapter.

**Customizing Node Parameters with User Controls**

The user interface for each node in Fusion is designed to provide access to the parameters in a logical manner. Sometimes, though, you may want to add, hide, or change the controls. This is commonly done for simple expressions and macros, but it can be done for usability and aesthetic reasons for favorites and presets.

User custom controls can be added or edited via the Edit Control dialog. Right-click the name of a node in the Inspector (in the header bar) and choose Edit Control from the contextual menu. A new window will appear, titled Edit Control.

In the Input attributes, you can select an existing control or create a new one, name it, define the type, and assign it to a tab. In the Type attributes, you define the input controls, the defaults and ranges, and whether it has an onscreen preview control. The Input Ctrl attributes box contains settings specific to the selected node control, and the View Ctrl attributes box contains settings for the preview control, if any.
All changes made using UserControls are stored in the node instance itself, so they can be copy/pasted, saved to a setting, added to the Bins, or added to your favorites.

**An Example of Customizing Directional Blur**

In the following example, let’s suppose we wanted to create a more intuitive way of controlling a linear blur than using the Length and Angle sliders independently.

![Default Directional Blur controls in the Inspector](image1)

We could use the Center input control, along with its preview control, to set an angle and distance from directly within the viewer using expressions.

1. Right-click the label for the Length parameter, choose Expression from the contextual menu, and then paste the following expression into the Expression field that appears:
   
   \[-\sqrt{((\text{Center.X-.5)}(\text{Input.XScale}))^2+((\text{Center.Y-.5)}(\text{Input.YScale})(\text{Input.Height/ Input. Width})^2)}\]

2. Next, right-click the label for the Angle parameter, choose Expression from the contextual menu, and then paste the following expression into the Expression field that appears:
   
   \[\text{atan2(Center.Y-.5)/(Input.OriginalWidth/ Input.X , .5-Center.X) * 180 / pi}\]

![Directional Blur controlled by the Center’s position](image2)
This functions fine, but the controls are confusing. The Center control doesn’t work as the center anymore, and it should be named “Blur Vector” instead. The controls for the Length and Angle aren’t meant to be edited, so they should be hidden away, and we’re only doing a linear blur, so we don’t need the buttons for Radial or Zoom. We just need to choose between Linear and Centered.

**Adding Another Control**

For the first task, let’s rename the Center. From the Add Control window, select Center from the ID list. A dialog will appear asking if you would like to Replace, Hide, or Change ID. We’ll choose Replace. Now we are editing the Center input. We’ll change the Name to Blur Vector, set the Type to Point, and the Page to Controls, which is the first tab where the controls are normally. Press OK, and our new input will appear on our node in the Node Editor. The ID of the control is still Center, so our SimpleExpressions did not change.

To hide the Length and Angle, we’ll run the UserControls script again. This time when we select the Length and Angle IDs, we’ll choose Hide in the dialog. Press OK for each.

Finally, to change the options available in the Type, we have two options. We can hide the buttons and use a checkbox instead, or we can change the MultiButton from four entries to two. Let’s try both.

To add the checkbox, run UserControls again, but this time instead of selecting an existing ID, we’ll type Centered into the Name. This will set the name and the ID of our input to Centered. The Type is set to Number, and the Page is set to Controls. Now in the Type Attributes, set the Input Ctrl to be CheckboxControl. Press OK, and now we have our checkbox. To make the new control affect the Type, add a SimpleExpression to the Type:

```
iif(Centered==1, 2, 0).
```

Once that’s done, we can use the UserControls to hide the Type control.

To make a new MultiButton, run the UserControl script, and add a new control ID, TypeNew. You can set the Name to be Type, as the Names do not need to be unique, just the IDs. Set the Type to Number, the Page to Controls, and the Input Ctrl to MultiButtonControl. In the Input Ctrl attributes, we can enter the names of our buttons. Let’s do Linear and Centered. Type them in and hit Add for each. Press OK, and we have our new buttons with the unneeded options removed. To make this new control affect the original Type, add a SimpleExpression to the Type:

```
iif(TypeNew==0, 0, 2).
```

Once that’s done, we can use the UserControls to hide the original Type control.
Chapter 70

Animating in Fusion’s Keyframes Editor

This chapter covers how you can keyframe effects in the Inspector, and how you can edit clips, effects, and keyframes in the Keyframes Editor.

Contents

**Keyframing in the Inspector**

Removing Animation in the Inspector 1213
Attaching a Parameter to an Existing Animation Curve 1213

**Keyframes Editor Overview**

Keyframes Editor Tracks 1214
The Timeline Header 1214
The Playhead 1215
Spreadsheet 1215

**Scaling and Panning the Timeline**

1216

**Working with Segments in the Timeline**

Moving Segments in the Timeline 1216
Trimming Segments 1217
Holding the First or Last Frame 1217

**Working with Keyframes in the Timeline**

Drag and Drop Keyframe Editing 1218
Keyframe Editing Using the Time Editor 1218
The Keyframe Spreadsheet 1218
Duplicating Spline Keyframes 1219
Time Stretching Keyframes 1219
Showing Keyframe Values 1219

**Timeline Filters**

Selected Filtering 1221
Most parameters in most effects nodes can be keyframed in order to create animated effects such as animated transforms, rotoscoping with splines, dynamically altering warping behaviors, and more; the list is endless.

For convenience, a set of keyframing controls is available within the Inspector next to each keyframmable parameter. These controls are:

- A gray Keyframe button to the right each keyframmable parameter. Clicking this gray button creates a keyframe at the current position of the playhead, and turns the button orange.
- Whenever the playhead is sitting right on top of a keyframe, this button turns orange. Clicking an orange Keyframe button deletes the keyframe at that frame and turns the button gray again.
- Small navigation arrows appear to the right and left if there are more keyframes in those directions. Clicking on navigation arrows to the right and left of keyframes jumps the playhead to those keyframes.

Once you’ve keyframed one or more parameters, the node containing the parameters you keyframed displays a Keyframe badge to show that node has been animated.
Once you’ve started keyframing node parameters, you can edit their timing in the Keyframes Editor and/or Spline Editor.

**Removing Animation in the Inspector**

**To remove a keyframed spline from a parameter:**

1. Right-click the keyframe control of the parameter you want to remove animation from.
2. Choose Remove [Name of parameter] from the contextual menu.

**Attaching a Parameter to an Existing Animation Curve**

Multiple parameters can be connected to the same animation curve. This can be an invaluable timesaver if you are identically animating different parameters in a node.

**To connect a second parameter to the same animation curve:**

1. Right-click on the second parameter you want to attach.
2. In the contextual menu, hover over the Connect To submenu.
3. In the Connect To submenu, choose the name of the animated parameter.

**Keyframes Editor Overview**

The Keyframes Editor is essentially a timeline view of your composition, within which each clip and effect node in your composition is represented by a track. These tracks have the same color coding as the nodes they represent and are labeled where appropriate. A Time Ruler at the top indicates the timing of your composition, while numerous controls let you control the contents of the Keyframes Editor.

The Keyframes Editor can be used for one of two things:

- To adjust the timing of elements in a project, whether they’re clips or effects. You can trim, slide, and extend clips, adjust the timing of an animation spline, or trim the duration of an effects node. You can freely rearrange the order of nodes in the Timeline without affecting the layering order of your composition. All compositing operations are handled in the Node Editor, while the Keyframes Editor manages the timing of your composition.

- To create and/or edit keyframes that you’ve applied to effects in a track-based manner, you can retime keyframes, add and delete keyframes, and even edit keyframe values.
To show the Keyframes Editor, do one of the following:

- Click the Keyframes Editor button in the UI toolbar to toggle visibility of the Keyframes Editor on and off.
- Press F7 on the keyboard.

Keyframes Editor Tracks

While each clip and effect node in your composition is represented by a track, keyframed parameters are exposed either as keyframes superimposed upon the track to which they’re applied (as seen on the MOVEMENT track), or they can be opened up onto their own tracks for more precise editing, one keyframe track per keyframed parameter, by clicking a disclosure control to the left of that track’s name in the Timeline header (as seen under the “Drip1” track).

The Timeline Header

The Timeline header area on the left side of the Timeline is a hierarchical list of all tracks in a composition. Each track displays the name of its corresponding node, a lock button, and a disclosure control for revealing keyframe tracks for each keyframe animation, modifier, and mask that’s attached to it.
**Collaps/ove All**
A quick way to open or close all available keyframe tracks at once is to use the Expand/Collapse Tool Controls commands in the Keyframe Timeline Option menu.

**The Playhead**
As elsewhere in Fusion, the playhead is a red vertical bar that runs through the Timeline view to indicate the position of the current frame or time. The Keyframes Editor playhead is locked to the viewer playhead, so the image you’re viewing is in sync.

You must click on the playhead directly to drag it, even within the Timeline ruler (clicking and dragging anywhere else in the Timeline ruler scales the Timeline). Additionally, you can jump the playhead to a new location by holding down the Command-Option keys and clicking in the track area (not the Timeline ruler).

![The playhead about to be dragged by the pointer](image)

**Spreadsheet**
If you turn on the Spreadsheet and then click on the name of a layer in the keyframe track, the numeric time position and value (or values if it’s a multi-dimensional parameter) of each keyframe appear as entries in the cells of the Spreadsheet. Each column represents one keyframe, while each row represents a single aspect of each keyframe.

![Editing keyframes in the Spreadsheet](image)

For example, if you’re animating a blur, then the Key Frame row shows the frame each keyframe is positioned at, and the Blur1BlurSize row shows the blur size at each keyframe. If you change the Key Frame value of any keyframe, you’ll move that keyframe to a new frame of the Timeline.
Scaling and Panning the Timeline

At the top, a series of zoom and framing controls let you adjust the work area containing the layers.

– A Horizontal zoom control lets you scale the size of the editor.
– A Zoom to Fit button fits the width of all tracks to the current width of the Keyframes Editor.
– A Zoom to Rect tool lets you draw a rectangle to define an area of the Keyframes Editor to zoom into.
– A Sort pop-up menu lets you sort or filter the tracks in various ways.
– An Option menu provides access to many other ways of filtering tracks and controlling visible options.

Working with Segments in the Timeline

Most of the work in the Timeline involves trimming and aligning clip segments.

To select a single segment in the Timeline, do one of the following:

– Click the node’s name in the header.
– Click the node’s segment in the Timeline.

To add another segment to the selection, do one of the following:

– Hold Command and click additional segments to select discontiguous selections.
– Select a segment, and then hold Shift and click another segment to make a contiguous selection of all segments in between.

To remove a segment from the selection, do the following:

– Hold Command and click a selected segment to deselect it.

TIP: Selecting a node’s name from the Timeline header also selects the node’s tile in the Node Editor, with its controls displayed in the Inspector.

Moving Segments in the Timeline

To move the position of a segment, drag on the node’s segment in the Keyframes Editor. The cursor will resemble a bar with two arrows pointing in either direction. Moving a segment changes where that clip begins and ends in the composition.
Trimming Segments

Trimming segments has different effects on Loaders, Medialn and Effect nodes:

– Trimming a Loader or Medialn node is similar to trimming clips in an editing application, in that you’re changing the in and out points of the range of media that clip makes available to your composition.

– Trimming the segments of effect nodes instead modifies the range of that node’s effect in the composition. Outside of the trimmed region, that effect node will behave as if it were disabled.

**TIP:** Shortening the duration of effects nodes can optimize processing. Imagine a Loader or Medialn node that represents a clip that’s 100 frames long and is connected to a Defocus node that’s animated from frames 80–100. There is little to no point in processing the defocus node between frames 0–79, so trimming the defocus segment to start at frame 80 in the Timeline will effectively prevent it from rendering and consuming either memory or processor time until needed.

To trim a segment in the Timeline, do the following:

– Drag on either end of the node’s segment in the Timeline.

The cursor changes to a vertical bar with a single arrow when the cursor is in the right location to trim.

Holding the First or Last Frame

If you want to hold a Loader’s first or last frame of a clip for a certain number of frames, also called a freeze frame, you can hold Command while you drag beyond the first or last of the segment in the Timeline.

Working with Keyframes in the Timeline

Keyframes can be drawn in one of two ways. When keyframe tracks are closed, they’re drawn over the node’s segment. Clicking on the disclosure icon to the left of the node’s name in the track header expands the display so each keyframed parameter has its own track in the Timeline, enabling precise editing.

Furthermore, each keyframe track, whether open or closed, exposes a miniature curve overlay that provides a visual representation of the rise and fall of keyframed values. This little overlay isn’t directly editable.

The Drip1 segment has its keyframe tracks exposed, while the Text1 segment has its keyframe tracks collapsed so they’re displayed within the segment.
Drag and Drop Keyframe Editing

Here are pointer-based keyframe editing methods that will get you started.

**Methods of selecting keyframes:**
- Click a single keyframe to select it.
- Drag a bounding box over a series of keyframes to select them all.
- Command-click to select discontiguous keyframes.
- Shift-click the first and last of a range of keyframes to select a contiguous range.

**Methods of adjusting keyframes:**
- You can drag keyframes left and right to reposition them in time.
- You can right-click one or more selected keyframes and use contextual menu commands to change keyframe interpolation, copy/paste keyframes, or even create new keyframes.

Keyframe Editing Using the Time Editor

A drop-down and editing field at the bottom right of the Keyframes Editor lets you numerically edit the timing, in frames, of any selected keyframe, making it easy to make precise adjustments.

**To change the position of a keyframe using the toolbar, do one of the following:**
- Select a keyframe, and then enter a new frame number in the Time Edit box.
- Choose T Offset from the Time Editor drop-down, select one or more keyframes, and enter a frame offset.
- Choose T Scale from the Time Editor drop-down, select one or more keyframes, and enter a frame offset.

The Time button can switch to Time Offset or Time Scale for moving keyframes.

The Keyframe Spreadsheet

If you turn on the Spreadsheet and then click on the name of a layer in the keyframe track, the numeric time position and value (or values if it’s a multi-dimensional parameter) of each keyframe appear as entries in the cells of the Spreadsheet. Each column represents one keyframe, while each row represents a single aspect of each keyframe.

For example, if you’re animating a blur, then the Key Frame row shows the frame each keyframe is positioned at, and the Blur1BlurSize row shows the blur size at each keyframe. If you change the Key Frame value of any keyframe, you’ll move that keyframe to a new frame of the Timeline.
Duplicating Spline Keyframes

Keyframes can be duplicated, either onto the same keyframe track or onto different tracks. This can save you time if you need to repeat a keyframe sequence at another time on the same segment, or even just create identically-timed keyframes on two different segments.

To duplicate keyframes, do the following:

1. Select one or more keyframes you want to duplicate.
2. Hold Command and drag one of the selected keyframes to a new position.

Time Stretching Keyframes

If you select a range of keyframes in a keyframe track, you can turn on the Time Stretch tool to show a box you can use to squeeze and stretch the entire range of keyframes relative to one another, to change the overall timing of a sequence of keyframes without losing the relative timing from one keyframe to the next. Alternatively, you can turn on Time Stretch and draw a bounding box around the keyframes you want to adjust to create a time-stretching boundary that way. Click the Time Stretch tool again to turn it off.

![Time stretching keyframes](image)

Showing Keyframe Values

When a node and its accompanying segment have animated parameters, keyframes appear as colored tick marks in keyframe tracks to indicate when animated changes occur. If the tracks and splines are open on a parameter, choosing Show Values from the Keyframes Editor Option menu shows editable fields beneath each keyframe. These fields show each keyframe’s current value and allow you to edit them simply by entering a new number.

![Show values from the Keyframes Editor Option menu](image)

Timeline Filters

When a composition grows to include hundreds of nodes, locating specific node layers can quickly become difficult. Timeline filters can be created and applied to sift out nodes that are not necessary to the current operation. The Global Timeline preferences include a number of pre-made filters that you can enable, or you can create new ones as needed.

To use a Timeline filter:

Open the Keyframes Editor Option menu and choose an item from the top of the menu. Default Timeline filters include:

- Show All, which shows all node layers in the current composition.
- Show None, which hides all layers.
– Show Tools at Current Time, which only displays node layers under the playhead.
– If you’ve created custom filters, they appear here as well, in alphabetical order.

To go back to showing everything:
– Choose Show All from the Keyframes Editor Option menu. All layers will reappear.

To create a Timeline filter:
1 Choose Create/Edit Filters from the Keyframes Editor Option menu to open the Timeline panel of the Fusion Settings window. This is where you can create new Timeline filters.

2 Click the New button, enter a name for your new filter setting, and click OK. The filter you created is now selected in the Filter pop-up menu at the top.

3 Use the “Settings for filters” list to turn on the checkboxes of nodes you want to be seen and turn off the checkboxes of nodes you want to filter out. Each category of node can be turned on and off, or you can open up a category’s disclosure control to turn individual nodes on and off. Clicking Invert All immediately turns off all node categories.

4 When you’re finished creating filters, click the Save button to hide the Fusion Settings window.

Filters that you’ve created in the Timeline panel of the Fusion Settings window appear in the Keyframes Editor Option menu.
To delete a filter:
1 Choose Create/Edit Filters from the Keyframes Editor Option menu to open the Timeline panel of the Fusion Settings window. This is where you can delete Timeline filters.
2 Choose the filter you want to delete from the Filter pop-up menu.
3 Click the Delete button, and when a dialog asks if you really want to do that, click OK.

Selected Filtering
Choosing “Show only selected tools” from the Keyframes Editor Option menu filters out all segments except for layers corresponding to selected nodes. This option can be turned on or off.

**TIP:** When “Show only selected tools” is enabled, you can continue to select nodes in the Node Editor to update what’s displayed in the Keyframes Editor.

Sorting in the Timeline
You can change the order in which the nodes are displayed from top to bottom in the Timeline.

- You can use the Tree Item Order Selection menu to sort the tracks by an assigned number.
- You can use the Sort pop-up menu.

The Tree Item Order Menu
Right-clicking over any track on the Keyframes Editor will display a contextual menu that contains the Tree Item Order Selection submenu. Choosing Start from the submenu allows you to start numbering each item in the track header by clicking on them. The first item you click will be #1, the second item #2, the third #3, and so on. Once you have selected all the items in the order you want them to be organized in the Keyframes Editor, right-click over a track, and from the Tree Item Order Selection submenu, choose End. The items will be ordered using the assigned numbers, with #1 appearing above #2, which appears above #3, and so on. The first items in the Keyframe track list will always be the nodes that are the root of the node tree. The numbered nodes will appear in order after the root nodes. For example, if the node tree starts with a background node, and then connects to a Fast Noise, Blur, and Color Corrector, the background node will always appear at the top of the Keyframes Editor track list because it is the root node.

The Keyframes Editor Tree Item Order Selection menu

If you begin numbering nodes in the track header and change your mind or decide on a different order, you can choose Restart to begin numbering again or choose Cancel to keep the current order.
The Sort Menu

The Sort menu reorders how the layers of each node appear in the Keyframes Editor. Setting the menu back to All Tools will display them in a linear order, scanning the Node Editor from left to right and top to bottom. This is the default setting.

- **All Tools**: Forces all tools currently in the Node Editor to be displayed in the Keyframes Editor.
- **Hierarchy**: Sorts with the most background layers at the top of the header, through to the most foreground layers at the bottom, following the connections of the nodes in the Node Editor.
- **Reverse**: The opposite of Hierarchy, working backward from the last node in the Node Editor toward the most background source node.
- **Names**: Sorts by the alphabetical order of the nodes, starting at the top with the beginning of the alphabet.
- **Start**: Orders layers based on their starting point in the composition. Nodes that start earlier in the Global project time are listed at the top of the header, while nodes that start later are at the bottom.
- **Animated**: Restricts the Timeline to showing animated layers only. This is an excellent mode to use when adjusting the timing of animations on several nodes at once.

Markers

Markers help identify important frames in a project that might affect how you keyframe animation. They may indicate the frame where a dragon breathes fire at a protagonist, the moment that someone passes through a portal, or any other important frame in a composition that you need to keep track of. Markers added to the Timeline in the Cut, Edit, Fairlight, or Color page will appear in the Keyframes Editor and Spline Editor of the Fusion page. They can also be added from the Keyframes Editor or the Spline Editor while working in Fusion Studio or the Fusion page. Markers in Fusion appear as a small handle with a line extending vertically through the graph view when selected.
To create a marker, do the following:
- Right-click at a frame in the Timeline Ruler of the Keyframes Editor and choose Add Marker from the contextual menu.

The most important attribute of a marker is its position. For it to add value, a marker must be placed on the frame you intended it to be on. Hovering the cursor over a marker displays a tooltip with its current frame position. If it is on the wrong frame, you can drag it along the Time Ruler to reposition it.

Markers added to the Time Ruler are editable in the Fusion page, and the changes appear back in the other DaVinci Resolve pages. Time Ruler markers can be added, moved, deleted, renamed, and given descriptive notes from within Fusion’s Keyframes or Spline Editor.

**NOTE:** Markers attached to clips in the Edit page Timeline are visible on MediaIn nodes in Fusion’s Keyframes Editor but not editable. They are not visible in the Spline Editor.

**Jumping to Markers**
Double-clicking a marker jumps the playhead to that marker’s position.

**Renaming Markers**
By default, a marker uses the frame number in its name, but you can give it a more descriptive name to go along with the frame number, making it easier to identify. To rename a marker in Fusion, right-click over the marker and choose Rename Guide from the contextual menu. Enter a name in the dialog and click OK.

**Show Marker List**
Markers can be used to jump to specific locations in a composition using the Marker List. If you right-click over a marker or within the Keyframe Editor Time Ruler to bring up the contextual menu, you can choose Show Marker List, or press Shift-G, to display the Marker List dialog. The Marker List is a floating dialog that will remain on top of the main window until closed.

The Marker List shows all the current markers in the composition, listed according to their position in time along with any custom name you’ve given them. If you double-click a marker’s name from the list, the playhead jumps to the marker’s location.
The Marker List dialog allows you to navigate through a composition using markers.

There is a pair of checkboxes beside the names of each marker. One is for the Spline Editor, and one is for the Keyframes Editor. By default, markers are shown in both the Spline Editor and Keyframes Editor, but you can deselect the appropriate checkbox to hide the markers in that view.

**Deleting Markers**

You can delete a marker by dragging it up beyond the Time Ruler and releasing the mouse. You can also use the marker's contextual menu to choose Delete Marker.

**Autosnap**

To help with precisely positioning keyframes and the start and end of segments as you drag in the Timeline, you can have them snap to a field, a frame, or to markers. The Autosnap option is accessed through the Keyframes Editor’s contextual menu. There are two submenu options for autosnapping. One option controls the snapping behavior when you drag keyframes, control points, or the starting and ending edges of segments. The other option controls the snapping behavior of markers.

**Autosnap Points**

When you drag keyframes or the edges of segments, often you want them to fall on a specific frame. Autosnap restricts the placement of keyframes and segment edges to frame boundaries by default, but you have other options found in the contextual menu. To configure autosnapping on keyframes and segment edges, right-click anywhere within the Keyframes Editor and choose Options > Autosnap Points from the contextual menu. This will display the Autosnap Points submenu with options for the snapping behavior. The options are:

- **None**: None allows free positioning of keyframes and segment edges with subframe accuracy.
- **Frame**: Frame forces keyframes and segment edges to snap to the nearest frame.
- **Field**: Field forces keyframes and segment edges to snap to the nearest field, which is 0.5 of a frame.
- **Guides**: When enabled, the keyframes and segment edges snap to markers.

**Autosnap Markers**

When you click to create a new marker, the default behavior is that it will snap to the closest frame. If you reposition the marker, it also snaps to the nearest frame as you drag. This behavior can be changed in the Keyframes Editor’s contextual menu by choosing from the Options > Autosnap Markers submenu. The options are:

- **None**: Markers can be placed anywhere with subframe accuracy.
- **Frame**: Frame forces all markers to snap to the nearest frame.
- **Field**: Field forces all markers to snap to the nearest field.
The Spreadsheet Editor

The Spreadsheet Editor is a separate panel that can be displayed beneath the Keyframes Editor. It is used to compactly show the numeric values of the keyframes for selected parameters in the Keyframes Editor’s header, via a table with rows and columns, showing time and value.

To reveal the Spreadsheet Editor, click on the Spreadsheet button in the toolbar. The Spreadsheet will split the Work Area panel and appear below the Keyframes Editor’s interface.

Selecting a Node to Edit

To display a node’s timing in the Spreadsheet, select the node’s name in the Keyframes Editor header. The Start and End points of the selected node will appear in the keyframe’s line of the Spreadsheet.

To edit an animation parameter in the Spreadsheet Editor, select the parameter in the Keyframes Editor header. The keyframe row includes a box for each frame number that contains a keyframe. The value of the keyframe is displayed in the cell below the frame number. Clicking on a cell allows you to change the frame number the keyframe is on or the parameter’s value for that keyframe.

**TIP:** Entering a frame number using a decimal point (e.g., 10.25 or 15.75) allows you to set keyframes on a subframe level to create more natural animations.

Inserting Keyframes

You can also add new keyframes to an animation by clicking in an empty keyframe cell and entering the desired time for the new keyframe. Using the cell under the new keyframe, you can enter a value for the parameter.

Selecting Multiple Nodes to Edit

Multiple splines and nodes can be edited together in the Spreadsheet. By default, selecting a new parameter in the Timeline header will replace the parameter and keyframes currently listed in the Spreadsheet Editor. Holding down Command, you can click on additional parameters on different nodes to add them to the Spreadsheet.

**TIP:** You can use the Tab and Shift-Tab key shortcuts to move the selection right or left in the Spreadsheet Editor.
Customizing the Keyframes Editor

There are a few ways you can change the appearance of the Keyframes Editor to better fit your needs. All these options are found by right-clicking anywhere within the Keyframes Editor and choosing an option from the contextual menu that appears.

Line Size

The Line Size option controls the height of each Timeline segment individually. It is often useful to increase the height of a Timeline bar, especially when editing or manipulating complex splines.

Methods of increasing or decreasing the height of segments:

- To change the height of just one segment: Right-click anywhere within the Keyframes Editor and choose a size from the Line Size submenu. The options are Minimum, Small, Medium, Large, and Huge.

- To change the height of all segments: Right-click anywhere within the Keyframes Editor and choose a size from the All Line Size submenu. The options are Minimum, Small, Medium, Large, and Huge.

Display Point Values

A more traditional view of keyframes is to view them as control points instead of vertical bars, making them easier to select for some people. From the Timeline contextual menu, you can right-click anywhere within the Keyframes Editor and choose Options > Display Point Values to change how keyframes look.

Here are the two options, compared.

Keyframes displayed as bars (left), and keyframes displayed as Point Values (right).
Displaying Audio Waveforms
You can display a MediaIn node’s audio waveform in the Keyframes Editor and use it as a guide as you add and move keyframes.

To display the audio waveform in the Keyframes Editor:
1. Open the Keyframes Editor.
2. Click the disclosure arrow next to the MediaIn node to view the audio waveform for that clip.

To change the size of an audio waveform display:
1. Open the Keyframes Editor.
2. In the Keyframes Editor, select the audio track of the waveform you want to modify.
3. Right-click over the audio waveform and choose Line Size > Minimum/Small/Medium/Large/Huge.

When using Fusion Studio, you can view the audio waveforms in the Keyframes Editor by displaying the Saver node.

To view the Audio Waveform in Fusion Studio, do the following:
1. Open the Keyframes Editor.
2. Expand the Saver track to view the audio waveform.

When you want to find the precise location of an audio beat, transient, or cue, you can slowly drag over the audio waveform to hear the audio. If you need to see more resolution in the waveform display, you can increase the size.

To change the size of an audio waveform display:
1. Open the Keyframes Editor.
2. Right-click over the audio waveform and choose Line Size > Minimum/Small/Medium/Large/Huge.

**Tip:** Right-clicking a track in the Keyframes Editor and choosing All Line Size > Minimum/Small/Medium/Large/Huge changes all the tracks and audio waveforms in the Keyframes Editor.
Chapter 71

Animating in Fusion’s Spline Editor

This chapter covers how you can keyframe effects and control animations in Fusion’s Spline Editor.

Contents

Spline Editor Overview 1229
Spline Editor Interface 1230
The Graph, Header, and Toolbar 1230
Renaming Splines 1231
Changing Spline Colors 1232
Navigating Around the Spline Editor 1232
Markers 1233
Autosnap 1235
Creating Animation Splines 1236
Animating with Different Spline Types 1236
Working with Keyframes and Splines 1238
Adding Keyframes 1238
Locked and Unlocked Controls Points 1239
Selecting, Moving, and Deleting Keyframes 1240
Showing Key Markers 1241
Copying and Pasting Keyframes 1241
Time and Value Editors 1243
Modifying Spline Handles 1244
Reducing Points 1245
The Spline Editor is the main area where animation is manipulated and refined. You primarily use the Spline Editor to show the changing values of parameters over time in the form of splines. Whereas Keyframes explicitly set the value of a parameter on a given frame, Splines are lines or curves that interpolate the values between keyframes. Once you set a keyframe on a parameter, a spline is created and can be displayed in the Spline Editor so you can make further refinements to the animation. However, the Spline Editor is more advanced than a standard curve editor since it can also display functions, which may not be splines, like changing characters within a text string or mathematical expressions that drive your animations.

What Are Splines?
All animation uses splines that describe the value of a parameter at any given point in time. The Spline Editor graph shows the time of the comp along the horizontal axis and the value of the parameter along the vertical axis.
The advantage of using splines to represent animation instead of keyframes as in the Keyframes Editor is that splines allow you to manipulate the interpolation between keyframes. For example, if a keyframe is set at a value of 1.0 on a parameter for frame 1, followed by a keyframe value of 10.0 for frame 10, the values between keyframes are smoothly interpolated or calculated based on the shape of the spline. Using the functions and controls in the Spline Editor, you have a fantastic amount of control over that interpolation.

**Spline Editor Interface**

The Spline Editor is not visible by default, but you can show it at any time by clicking the Spline button in the user interface toolbar. You can also display the Spline Editor by right-clicking on a node in the Node Editor or a segment in the Keyframes Editor and choosing Edit Splines from the drop-down menu.

The Spline Editor can be open alongside the Node Editor or Keyframes Editor, or displayed separately in order to take up the entire work area.

**The Graph, Header, and Toolbar**

The Spline Editor has three main working areas: the graph, header, and toolbar. On the left side of the Spline Editor is the header, which shows a list of animated parameters. The majority of the panel is taken up by the splines displayed in the graph area, and a toolbar runs along the bottom, providing a variety of ways to manipulate the splines.

**Graph**

The graph is the largest area of the interface. It is here that you see and edit the animation splines. There are two axes in the graph. The horizontal axis represents time, and the vertical axis represents the spline's value. A thin bar, called the playhead, runs vertically through the graph to represent the current time as it does in the Timeline Editor. You can drag the playhead to change the current time, updating the frame displayed in the viewers.

**Spline Editor Header**

The header provides a mechanism for determining what splines are visible in the graph. It shows the name of each spline in the project beneath the tool that contains that parameter. The checkbox beside each name shows whether that spline is currently displayed in the graph and whether the spline can be edited.
Spline Editor Toolbar

The toolbar across the bottom of the Spline Editor represents the most common operations applied to an animation spline. The various operations represented in the toolbar are all accessible from the graph’s context menu as well, but the following buttons provide a faster shortcut.

Playhead

The playhead is the thin red vertical bar that runs vertically through the Spline Editor graph and represents the current time of the comp. You can drag the playhead to change the current time.

Status Bar

The status bar in the lower-right corner of the Fusion window regularly displays information about the position of the pointer, along with the time and value axes.

Contextual Menus

There are two contextual menus accessible from the Spline Editor. The Spline contextual menu is displayed by right-clicking over the graph, while the Guide contextual menu is displayed by right-clicking on the Time Ruler above the graph.

Renaming Splines

The name of a spline in the header is based on the parameter it animates. You can change the name of a spline by right-clicking on it in the header and choosing Rename Spline from the contextual menu.
Changing Spline Colors

Each spline in the graph is assigned a different color, making individual splines easier to identify when multiple splines are visible at once. When the spline is active, a round color swatch is displayed next to the spline’s name in the header.

To change the color of a spline:
1. Right-click on the name of the spline in the header and choose Change Color from the contextual menu.
2. Select the new color from the dialog box that appears and click OK.

Navigating Around the Spline Editor

It is often necessary to magnify and pan around the graph area to ensure that the splines you want to work on are visible. In general, scaling and panning the Spline Editor works the same as in all navigable parts of the Fusion interface. However, there are several unique functions to the Spline Editor for controlling your view based on the height, width, and selection of multiple animation splines.

The most obvious navigation methods to use are the scale sliders and buttons located in the upper left of the Spline Editor panel.

The Zoom Height and Zoom Width sliders, Fit button, and Zoom to Rectangle button can be used to navigate around the graph.

To scale and pan using the sliders and buttons:
- Zoom Height and Zoom Width sliders let you change the height and width of the graph area.
- The Fit button attempts to rescale the view so that all currently active splines fit within the graph.
- The Zoom to Rectangle button (Command-R) allows you to draw a bounding box around the area of the graph you want centered and scaled.

To scale using the axis labels:
- Place the mouse pointer over the rulers for the horizontal or vertical axis and drag to resize the graph on that axis only. The view is scaled centered on the original position of the pointer on the ruler.

To scale and pan with the mouse and/or keyboard:
- With the Spline Editor active, press the + and - keys on your keyboard to zoom in and out of the graph.
- You can also zoom to a specific control point by holding down the Command key and scrolling the middle mouse wheel. The mouse pointer location determines the area that gets magnified.
- Position the mouse pointer over the graph, and then hold down the middle mouse button. With the middle mouse button pressed down, click once on the left mouse button to zoom in and once on the right button to zoom out.
To pan the graph area:

– Drag left or right using the middle mouse button or use the scroll bar along the bottom and right side of the graph.

Using the Graph contextual menu for navigation:

There are several ways to navigate the graph area using the Spline Editor contextual menu as well.

– Choose Scale > Scale to Fit (Command-F) to fit all active splines into the graph area.
– Choose Scale > Scale to Rectangle (Command-R) to draw a bounding box around the area of the graph you want centered and scaled. This has the same effect as clicking the Zoom to Rectangle button.
– Choose Scale > Default to reset the scaling of the graph area to default values.
– Choose Scale > Zoom In/Zoom Out to scale the graph area. This performs the same functions as pressing the + and - keys on the keyboard.
– Choose Scale > Auto Fit to scale the graph to fit all splines dynamically as you make splines visible and hidden. If the scaling is changed with Auto-Fit enabled, the graph area will scroll as you play the comp to view all the keyframes.
– Choose Scale > Auto Scroll to scroll the graph area if the splines fall outside the graph horizontally as you play.
– Choose Scale > Manual to disable all automatic attempts at showing splines in the graph.
– Choose Options > Fit Times to automatically scale along the X-axis to fit the selected spline. All visible splines are taken into account, not just the newly selected spline. With this option off, activating a new spline will not change the horizontal scale.
– Choose Options > Fit Values to automatically scale along the Y-axis to fit the selected spline. All visible splines are taken into account, not just the newly selected spline. With this option off, activating a new spline will not change the vertical scale.

Markers

Markers help identify important frames in a project. They may indicate a frame where a ray gun shoots a beam in the scene, the moment that someone passes through a portal in the image, or any other important event in the composite.

Markers added to the Timeline in the Cut, Edit, Fairlight, or Color page will appear in the Keyframes Editor and Spline Editor of the Fusion page. They can also be added from the Keyframes Editor or the Spline Editor while working in Fusion Studio or the Fusion page. Markers appear along the top of the horizontal axis Spline Editor’s Time Ruler. They are displayed as small blue shapes, and when selected, a line extends from each guide down vertically through the graph.

NOTE: Markers attached to clips in the Cut, Edit, Color, or Fairlight pages Timeline are not visible in Fusion’s Spline Editor.
Working with Markers

Markers call attention to a particular frame within a comp. They can be named, displayed in a list, and edited. After you add markers, you can easily jump the playhead between them, change their position, or delete them altogether.

To create a marker:
– Right-click in the horizontal axis Time Ruler and choose Add Guide.

To delete a marker, do one of the following:
– Drag the marker up outside the Spline Editor panel.
– Right-click on the marker and then choose Delete Guide from the menu.
– Select the marker and then press Delete or Backspace on the keyboard.
– From the Marker List, select a guide in the list and click the Del button.

To move a marker to a new frame, do one of the following:
– Drag the marker handle along the time axis.
– Right-click in the marker area and choose Options > Enable Guide Grabs, and then drag the marker’s vertical line to move the guide.

To move the Playhead to a marker:
– Right-click on a marker and choose Set Current Time To [Frame number].

Using the Marker List

The Marker List is a list of all markers in the current comp. It can display the markers from either the Keyframes Editor, the Spline Editor, or both panels simultaneously. Clicking on the frame number or name of a guide causes the current time to change to that marker’s frame. Since the Marker List is a floating window, it can remain open, allowing you to quickly jump to different markers while you work in the Spline Editor.

To show the Marker List:
– Right-click in the horizontal axis and choose Show Marker List, or press Shift-G.
If markers currently exist in the comp, they are automatically displayed in the Marker List, regardless of whether they were added in the Keyframes Editor or the Spline Editor or any other page in DaVinci Resolve. You can also add markers directly from the Marker List, which can be helpful if you have multiple markers you need to add, and you know the rough timing.

**To add a guide from the Marker List:**

1. Click the Add button in the Marker List window.
2. Enter a frame number in the Time field.
3. Press Tab or click the Close button to close the Marker List.

**To name a marker, do one of the following:**

- In the Marker List, double-click in the Name column, to the right of the frame number, and enter a name for the marker.
- Right-click over a marker in the horizontal axis and choose Rename Marker. In the dialog that opens, enter a name for the marker.

**Displaying Marker with the Timeline**

The Marker List window includes checkboxes next to each marker that determines whether a marker displays in the Spline Editor, the Keyframes Editor, both, or neither. By default, when you create markers, they are active in both panels. To hide a marker from appearing in either panel, deselect the appropriate checkbox.

**Autosnap**

To assist in precisely positioning keyframe control points along the horizontal (time) axis, you can enable the Spline Editor’s Autosnap function. Right-clicking over a spline and choosing Options > Autosnap provides a submenu with four options.

- **None**: Allows free, sub-frame positioning of the keyframes.
- **Frame**: Keyframes snap to the nearest frame.
- **Fields**: Keyframes snap to the nearest field.
- **Guides**: Keyframes snap to the nearest marker.

**Autosnapping and Markers**

By default, a newly-created marker snaps to the closest frame. Moving markers with the mouse also snaps them to the current frame. You can change this behavior by selecting Options > Autosnap Markers > None or by selecting Options > Autosnap Markers > Field from the contextual menu.
Creating Animation Splines

Animation splines are created automatically when you keyframe a parameter in the Inspector or the Keyframes Editor. However, you can create an animation spline without first having to add a keyframe.

To create a spline:
– Right-click on the parameter to be animated in the Inspector, and choose Animate from the contextual menu.

Choosing Animation from the menu displays a spline in the Spline Editor

Selecting Animate from the contextual menu connects the parameter to the default spline type. This is usually a Bézier Spline unless you change the default spline in the Defaults panel of the Fusion Preferences.

Deleting Animation Splines
To remove an animation spline from a parameter, right-click on the control and select Remove [tool parameter’s name] from the contextual menu. Removing a spline from a parameter only deletes the spline if no other tool in the composition is connected to the same spline at that time.

Removing a spline from a parameter removes the animation

Animating with Different Spline Types
A Bézier spline is the default spline unless changed in the Preferences. However, if you want to use a spline type other than Bézier for the animation curve, you can choose the spline type from the Modify With contextual submenu before creating any keyframes.
Three spline types in the Modify With menu

- **Bézier Spline**: Bézier splines are the default curve type. Three points for each keyframe on the spline determine the smoothness of the curve. The first point is the actual keyframe, representing the value at a given time. The other two points represent handles that determine how smoothly the curve for the segments leading in and out of the keyframe are drawn. Bézier is the most used spline type because Bézier splines allow you to create combinations of curves and straight lines.

- **Modify with > B-Spline**: B-splines use a single point to determine the smoothness of the curve. Instead of using handles, a single control point determines the value as well as the smoothness of the curve. Holding down the W key while dragging left or right on the control point adjusts the tension of the curve.

- **Modify with > Cubic Spline**: Cubic splines are similar to Bézier splines, in that the spline passes through the control point. However, Cubic splines do not display handles and always make the smoothest possible curve. In this way, they are similar to B-splines. This spline type is almost never used.
– **Modify with > Natural Cubic Spline:** Natural Cubic splines are similar to Cubic splines, except that they change in a more localized area. Changing one control point does not affect other tangents beyond the next or previous control points.

---

**Working with Keyframes and Splines**

Once you animate a parameter and display the Spline Editor, you can manipulate the spline’s keyframes (and thus the animation) in a variety of ways. By selecting Keyframe control points, you can move, copy, and change the interpolation of your animation.

**Adding Keyframes**

Once you create one keyframe, additional keyframes are automatically added to a spline whenever you move the playhead and change the value of that spline’s parameter. For example, if you change the strength of an animated glow at frame 15, a keyframe with the new value occurs on frame 15.

In the Spline Editor, control points can also be added directly to a spline by clicking on the spline where you want to add the new keyframe.

**Adding Keyframes at the Playhead**

If you want to add a new keyframe at the current playhead location, pressing Command-K on the keyboard or right-clicking in the graph and choosing Set Key adds a keyframe under the playhead.

**Adding Equal Keyframes**

If you want to hold a value over several frames, right-clicking in the graph area and choosing Set Key Equal To displays a submenu to add a new keyframe with a value equal to the next or the previous keyframe.
Locked and Unlocked Controls Points

When animating the Center X/Y or Pivot X/Y parameters on any tool, you create a displacement spline in the Spline Editor. The displacement spline represents the relative offset position of the animated object along its path. Since the displacement spline is relative, keyframes use a value between 0.0 and 1.0. A displacement value of 0.0 in the Spline Editor indicates that the object is at the very beginning of a path. A value of 1.0 indicates that the object is positioned at the end of the path.

Displacement paths are composed of locked and unlocked points. Whether a point is locked is determined by how you added it to the polyline. Locked points on the spline have an associated point in the viewer’s motion path; unlocked points do not have a corresponding point in the viewer’s motion path. Each has a distinct behavior, as described below.

**TIP:** You can convert displacement splines to X and Y coordinates by right-clicking over the motion path in the viewer and choosing Path#: Polyline > Convert to X/Y Path.
Locked Points
Locked points are the motion path equivalents of keyframes. They are created by moving the playhead position and changing the parameter value. These points indicate that the animated object must be in a specified position on a specified frame. Since these keyframes are only related to position along the path, they can only be moved horizontally along the spline’s time axis.

The locked points appear as larger-sized lock icons in the Spline Editor. Each locked key has an associated point on the motion path in the viewer.

Deleting a locked point changes the overall timing of the motion.

Unlocked Points
Unlocked points are created by clicking directly on the spline in the Spline Editor. These points give additional control over the acceleration along the motion path without adjusting the path itself. Conversely, you can add unlocked points in the viewer to control the shape of the motion path without changing the timing.

You can change an unlocked point into a locked point, and vice versa, by selecting the point(s), right-clicking, and choosing Lock Point from the contextual menu.

For more information on motion paths and locked keyframes, see Chapters 70 and 72 in the DaVinci Resolve manual or Chapters 9 and 11 in the Fusion Studio manual.

Selecting, Moving, and Deleting Keyframes
The placement of keyframes greatly affects the style of the animation. Using the graph, you can select keyframes and move them up or down to change their value or move them left and right to change the timing. Keyframes can be copied and pasted between splines and parameters.

Methods of selecting keyframes:
- Click directly on a keyframe on the spline, or drag a bounding box around the keyframe.
- Drag a bounding box that encompasses multiple keyframes to select more than one.
- To add or remove a keyframe from the current selection, hold down the Command key while selecting the keyframes. This will remove currently selected keyframes and add currently unselected keyframes.
- Press Command-A or right-click in the graph area and choose Select Points > Select All from the contextual menu.

Moving Keyframes
You can freely move keyframes with the mouse, keyboard, or the edit point controls. Keyframes can even pass over existing points as you move them. For instance, if a keyframe exists on frame 5 and frame 10, the keyframe at frame 5 can be repositioned to frame 15.

To move keyframes with the mouse:
- Drag the selected keyframe to its new position in the graph. If more than one keyframe is selected, all selected keyframes will be moved simultaneously.
- Hold down the Option key before dragging the keyframe to constrain its motion to a single axis.

To move keyframes with the keyboard:
- The Up and Down Arrow keys will adjust the value of the keyframes by a small amount.
- The current scale of the graph determines the degree of vertical movement applied to the value with each key press. The closer the zoom in the spline, the finer the adjustment.
- Hold down the Shift key while pressing the Up or Down Arrow keys to increase the value adjustment in larger increments.
To move keyframes using edit fields:

- The Value and Time Editors are found on the far right of the toolbar. These number fields allow explicit values to be entered for selected keyframes. These controls are explained in more depth later in this chapter.

To delete one or more keyframes:

- Select one or more keyframes and press the Delete or Backspace key on the keyboard. This only removes the keyframes; it does not remove the spline, even if there are no keyframes on the spline. To remove the spline, right-click over the parameter in the Inspector and choose Remove [parameter name].

Showing Key Markers

You can adjust the position of the keyframes in time, without worrying about manipulating splines, by using the key markers. The horizontal time axis can show markers that indicate the position of each keyframe. The display of these markers is enabled by right-clicking in the graph and choosing Show > Key Markers from the contextual menu, or by clicking on the Show Key Markers button in the toolbar.

![The key markers show keyframes in the horizontal axis using the same color as the splines](image)

Copying and Pasting Keyframes

To precisely match animation, Keyframes can be copied to a new location on the same spline or onto completely different splines and different tools.

There are two options in the graph’s contextual menu for copying keyframes. Choosing Copy Points (Command-C) copies all selected points. Choosing Copy Value copies a single point identified by the pointer from multiple selected points. This does not deselect your selection set, and you can pick out numbers as needed.

To copy and paste points to a new location on the same spline:

1. Select the desired keyframes on the spline.
2. Right-click over the spline and choose Copy Points from the contextual menu or press Command-C.
3. Click in an empty area of the graph to deselect all the copied points.
4. Move the playhead to the area of the spline where you want the points pasted and press Command-V.

Or, move the pointer over the spline where you want the points pasted, and when the spline highlights, right-click and choose Paste Points/Value.
Alternatively, you can copy and paste keyframes by dragging them with the mouse. After you select the points, hold down the Command key and drag the points along the spline to where you want them pasted.

**To copy and paste keyframes from one spline to another:**

1. Make one spline the active visible spline and select the desired keyframes on the spline.
2. Right-click over the spline and choose Copy Points from the contextual menu or press Command-C.
3. Set the spline to viewed or disabled using the status checkbox next to the spline’s name in the header.
4. Make the destination spline the active visible spline and select the keyframe on the spline where the new keyframes should be pasted.
5. Right-click and choose Paste Points/Value or press Command-V.

You can copy a single point’s value from a group of selected points. Since this process does not deselect the selected set, you can continue picking out values as needed without having to reselect points.

**To copy and paste a keyframe value:**

1. Make one spline the active visible spline and select all the keyframes on the spline.
2. Right-click over a single point and choose Copy Value from the contextual menu.
3. Set the spline to viewed or disabled using the status checkbox next to the spline’s name in the header.
4. Make the destination spline the active visible spline and select the keyframe on the spline where the new keyframe should be pasted.
5. Right-click and choose Paste Points/Value or press Command-V.

Keyframes can also be pasted with an offset, allowing you to duplicate a spline shape but increase the values or shift the timing using an offset to X or Y.

**To paste keyframes points and values with an X or Y offset:**

1. Make one spline the active visible spline and select the desired keyframes on the spline.
2. Right-click over the spline and choose Copy Points from the contextual menu or press Command-C.
3. Set the spline to viewed or disabled using the status checkbox next to the spline’s name in the header.
4. Make the destination spline the active visible spline and select the keyframe on the spline where the new keyframes should be pasted.
5. Right-click and choose Paste with Offset. In the Offset dialog, enter the Y value, which will be added to the values of the pasted keyframes.

**TIP:** You cannot copy and paste between different spline types. For instance, you cannot copy from a Bézier spline and paste into a B-spline.
Time and Value Editors

The Time and Value Editors in the lower-right corner of the Spline Editor are used to change the position and parameter value of a keyframe by entering a number into the number field for each button. Each field can switch between three modes that help modify the time and value of a keyframe in three precise but distinct ways. The default mode for each field takes the explicit frame number or parameter value at which you want the keyframe set. The other modes offset and scale the keyframe’s position or value.

Use the number fields to enter in a value or a specific time to change the selected keyframe.

Time Editor

The Time Editor is used to modify the current time of the selected keyframe. You can change the Time mode to enter a specific frame number, an offset from the current frame, or spread the keyframes based on the distance (scale) from the playhead. You can select one of the three modes from the Time mode drop-down menu.

Three time editing modes are selectable from the Time mode drop-down menu.

Time

The number field shows the current frame number of the selected control point. Entering a new frame number into the field moves the selected control point to the specified frame. If no keyframes are selected or if multiple keyframes are selected, the field is empty, and you cannot enter a time.

Time Offset

Selecting T Offset from the drop-down menu changes the mode of the number field to Time Offset. In this mode, the number field offsets the selected keyframes positively or negatively in time. An offset of either positive or negative values can be entered. For example, entering an offset of 2 moves a selected keyframe from frame 10 to 12. If multiple keyframes were selected in the previous example, all the keyframes would move two frames forward from their current positions.

Time Scale

Selecting T Scale from the drop-down menu changes the mode of the number field to Time Scale. In this mode, the selected keyframes’ positions are scaled based on the position of the playhead. For example, if a keyframe is on frame 10 and the playhead is on frame 5, entering a scale of 2 moves the keyframe 10 frames forward from the playhead’s position, to frame 15. Keyframes on the left side of the playhead would be scaled using negative values.

Value Editor

The Value Editor is used to modify the selected keyframe’s parameter value using one of three Value modes. You can change the Value mode to enter a specific value for a parameter, an offset from the value, or to spread the values. The mode is chosen from the Value mode drop-down menu.
Three value editing modes are selectable from the Value mode drop-down menu.

**Value**
The number field shows the value of the currently selected keyframes. Entering a new number into the field changes the value of the selected keyframe. If more than one keyframe is selected, the displayed value is an average of the keyframes, but entering a new value will cause all keyframes to adopt that value.

**Value Offset**
Choosing Offset from the drop-down menu sets the Value Editor to the Offset mode. In this mode, the value for the selected keyframes are offset positively or negatively. An offset of either positive or negative values can be entered. For example, entering a value of -2 changes a value from 10 to 8. If multiple keyframes are selected, all the keyframes have their values modified by -2.

**Value Scale**
Choosing Offset from the drop-down menu sets the Value Editor to the Scale mode. Entering a new value causes the selected keyframes' values to be scaled or multiplied by the specified amount. For example, entering a value of 0.5 changes a keyframe's value from 10 to 5.

**Modifying Spline Handles**
All Bézier spline keyframes have a pair of control handles to shape the spline as it passes through the key point. These handles are only displayed when the keyframe is selected. Initially, these handles are set to linear, creating straight line changes between keyframes. However, any control point can be made smooth by right-clicking over it and choosing Smooth or pressing Shift-S.

Moderating spline handles can mix linear and smooth curves.

Dragging on a keyframe's handles adjusts the slope of the segments passing through the spline. By default, the two control handles on a control point are locked together so that if one moves, the one on the other side moves with it. This maintains a constant tension through the keyframe. There are situations, however, when it is desirable to modify these control handles separately for a more pronounced curve or effect.

**To temporarily break the control handles on a Bézier spline, moving one independently of the other:**

1. Select the control point to be modified.
2. Hold down the Command key and drag one of the control handles. They will now move independently of each other, as long as the Command key is held down.
To treat all Bézier handles as independent in the Spline Editor:

– Right-click in the graph and choose Independent Handles from the Options contextual menu.

Enabling this option causes all the Bézier handles to be independent. This is the same as using the Command key when moving a handle, except it is applied to all control points until it is disabled.

Reducing Points

When there are too many control points too close together on a spline, you can choose Reduce Points to decrease their number, making it easier to modify the remaining points. The overall shape of the spline is maintained as closely as possible while eliminating redundant points from the path.

To reduce the number of points on a spline:

1. Select the range of keyframes you want to thin out.
2. Right-click in the graph area and choose Reduce Points from the contextual menu.
3. When the Reduce Points dialog appears, drag the slider to a lower value.

You can set the slider value as low as possible as long as the spline still closely resembles the shape of your original spline.

**TIP:** When the value is 100, no points will be removed from the spline. Use smaller values to eliminate more points.

Filtering the Spline Editor

The animation splines for multiple parameters can be displayed within the Spline Editor simultaneously, and Fusion offers several ways for you to choose which spline to view and which to edit.

A complex composition can easily contain dozens, if not hundreds, of animation curves. As a composition grows, locating a specific spline can become more difficult. There are two ways to filter the splines shown in the Spline Editor: display selected tools only or create a filter to show only certain tools.

The Spline Editor includes different ways to control which splines are displayed. The majority of these options are available in the Options menu, located in the upper-right corner of the Spline Editor panel.
- **Show Only Selected Tools:** You can choose to limit the splines displayed in the Spline Editor by showing only the splines from selected tools. Choosing this option at the top of the Options menu displays only the splines for tools currently selected in the Node Editor.

- **Show All/None:** The default behavior of the Spline Editor displays all the splines for all the nodes with animated parameters. You can override this by enabling Show Only Selected Tools in the Options menu. You can also disable the Show All setting by choosing Show None, in which case the Spline Editor remains empty.

- **Expose All Controls:** The Expose All Controls option is a way of not filtering the parameters. Choosing this option displays all parameters in the Spline Editor header for all nodes in the Node Editor. It can be a fast way of activating one of the parameters and automatically adding an animation spline for it if one does not exist.

With a large number of nodes displayed, which themselves might have a large number of parameters, this might lead to cluttering and slowing down the interface. This option is most effective when used in conjunction with the Show Only Selected Tool option to limit the number of nodes and parameters displayed and yield optimum performance.

- **Follow Active:** The Follow Active option is located by right-clicking in the graph and choosing Options > Follow Active. This option provides a way to filter the splines in the graph while not filtering the header list of tools. Where the Show Only Selected Tool option hides other tools in the header, the Follow Active option leaves the header displaying all the tools but automatically enables only the splines of the Active tool.

### Working with Filters

Filters allow you to select the specific types and classes of tools shown in the Spline Editor and Keyframes Editor. For example, you can make a filter that shows only particle nodes or one that only shows color correction and brightness/contrast tools.

**To create a filter:**

1. From the Options menu, choose Create/Edit Filters.
2. Click the New button to create a new filter and name the new filter in the dialog box.
3. Enable a checkbox next to the entire category or the individual tools in each category to determine the tools included in the filter.

![Enable each tool you want to keep in the Spline Editor when the filter is selected](image)

The Invert All and Set/Reset All buttons can apply global changes to all the checkboxes, toggling the selected states as described.
To switch the selection state of the categories when creating a filter list:
1. Click the Invert All button.
2. After configuring the custom filter, click the Save button to close the Settings dialog and save the filter.

To enable all checkboxes or disable all checkboxes:
1. Click the Set/Reset All button as many times as needed until all categories are either checked or unchecked.
2. After configuring the custom filter, click the Save button to close the Settings dialog and save the filter.

To apply a filter to the Spline Editor:
- Choose the desired filter by name from the Options menu. The filter applies to both the Spline Editor and the Timeline.

To disable a filter and show all tools in the Spline Editor again:
- Choose Show All from the Options menu.

Changing a Spline’s Status

The Spline header is a hierarchical list of animated parameters and their parent nodes. Clicking the disclosure arrow next to a tool’s name reveals all the names of the animated parameters on that tool. Clicking directly on the parameter name in the Spline header activates that spline for display and editing.

Tool Status Checkbox

Next to the name of each spline is a checkbox that indicates the spline’s status. When you select a parameter name, the checkbox becomes active, allowing you to see and edit the spline in the graph. There are three selection modes for each checkbox: active, viewed, and disabled. Clicking directly on
the checkbox will toggle it between these three states. Changing the state of the parent node checkbox sets the state for all splines for that node.

- **Active**: When the checkbox is enabled with a check mark, the spline is displayed in the graph and can be edited.
- **Viewed**: When the checkbox is enabled with a solid gray box, the spline is visible in the graph but cannot be edited. It is read-only.
- **Disabled**: When the checkbox is clear, the spline is not visible in the graph and cannot be edited.

![Checkboxes determine which splines are visible and editable](image)

### Selection States

There are three selection options, labeled Select All Tools, Deselect All Tools, and Select One Tool, that determine how the items in the Spline Editor header behave when a checkbox or label is selected to activate a spline. These states are located in the Options menu in the upper-right corner of the Spline Editor.

![The Options menu selection states make it easier to select and deselect all parameters in the header](image)

- **Select All Tools**: Choosing this option activates all splines for editing.
- **Deselect All Tools**: Choosing this option sets all spline checkboxes to disabled.
- **Select One Tool**: This option is a toggle. When Select One Tool is chosen from the menu, only one spline in the header is active and visible at a time. Clicking on any spline’s checkbox will set it to active, and all other splines will be cleared. When disabled, multiple splines can be active in the header.

### Selection Groups
It is possible to save the current selection state of the splines in the header, making selection groups that can easily be reapplied when needed. To create a selection group, right-click over any parameter in the header or in an empty area of the graph and choose Save Current Selection from the contextual menu. A dialog will appear to name the new selection.

To reapply the selection group, choose the selection group by name from the Set Selection menu in the same contextual menu. Other context menu options allow selection groups to be renamed or deleted.

### Reshaping Splines Using the Toolbar

There are several ways to manipulate the shape of a spline, thereby altering the animation that spline generates. Other than manually adjusting Bézier handles, you can quickly squash, stretch, loop, and reverse a spline. You can also quickly change the interpolation between keyframes from the default linear motion to more natural smooth motion. All these options are provided at the bottom of the Spline Editor in the toolbar. The toolbar is divided into different groups for setting interpolation, reversing splines, looping splines, time stretching, and reshaping splines.

#### Interpolation

Keyframes are specific frames in an animation where control points are set to exact values on a given parameter. Interpolation is the method used to fill in the unknown values between two keyframes. Fusion automatically interpolates between two keyframes. However, you may want to modify the interpolation to achieve a specific style of animation. The Spline Editor includes several interpolation methods you can choose from using the toolbar.

**Interpolation buttons in the toolbar:** Smooth, Linear, Invert, Step In, and Step Out

#### Smooth

A smoothed segment provides a gentle keyframe transition in and out of the keyframe by slightly extending the direction handles on the curve. This slows down the animation as you pass through the keyframe. To smooth the selected keyframe(s), press Shift-S or click the toolbar’s Smooth button.

**Smooth interpolation between keyframes**
Linear

A linear segment effectively takes the shortest route between two control points, which is a straight line. To make the selected keyframe(s) linear, press the L key or click the Linear button in the toolbar.

![Linear interpolation between keyframes](image)

**TIP:** Invert is used only for non-animated LUT splines, which are currently only available in the LUT Editor window.

Step In/Step Out

On occasion, it is not desirable to have any interpolation between two keyframes. Instead, the value of one keyframe may hold its value until another keyframe changes it. For these cases, use the Step In or Step Out mode.

Step In causes the value of the previous keyframe to hold, then jump straight to the value of the next keyframe.

![Step In holds a value until the next keyframe is reached in the comp](image)

Step Out causes the value of the selected keyframe to hold right up to the next keyframe.

![Step Out switches immediately to the next keyframe value in a comp](image)
Step In and Step Out modes can be set for selected keyframes by clicking on the toolbar buttons for each mode, or by right-clicking and choosing the appropriate option from the contextual menu. The keyboard shortcuts I and O can also be used to enable Step In and Step Out on selected keyframes.

Reversing Splines

Reverse inverts the horizontal direction of a segment of an animation spline. To apply reverse, choose a group of points in a spline and click the Reverse button, or right-click and choose Reverse from the contextual menu, or press the V key. The group of points is immediately mirrored horizontally in the graph. Points surrounding the reversed selection may also be affected.

Looping Splines

It is often useful to repeat an animated section, either infinitely or for a specified number of times, such as is required to create a strobing light or a spinning wheel. Fusion offers a variety of ways to repeat a selected segment.

Set Loop

To repeat or loop a selected spline segment, select the keyframes to be looped. Select Set Loop from the contextual menu or click on the Set Loop button in the toolbar. The selected section of the spline repeats forward in time until the end of the global range, or until another keyframe ends the repeating segment.

Changing and Removing the Loop

You can change the looped segment by modifying any of the keyframes or control points originally used to create the loop. Simply select one of the originating key points, make any necessary modifications, and the looped segment updates. To remove the loop, select the keyframes you used to create the loop, and then click the Loop button in the toolbar.
Ping-Pong
The Ping-Pong Loop mode repeats the selected segment, reverses each successive loop, and then
repeats. Ping-pong looping can be enabled on the selected segments from the context menu or
the toolbar.

A ping-pong section in the graph

Relative Loop
The Relative Loop mode repeats the segment like the Loop, but each repetition adds upon the last
point of the previous loop so that the values increase steadily over time.

A Relative Loop section in the graph

Looping Backward
You can choose Set Pre-Loop by right-clicking in the graph area and choosing it from the contextual
menu. This option contains the same options for looping as the Loop option buttons in the toolbar,
except that the selected segment is repeated backward in time rather than forward.

Repeating Splines X Number of Times
You can duplicate splines and repeat them a set number of times by right-clicking in the graph area
and choosing Duplicate from the contextual menu. Duplicated splines are like looped splines, except
that the selected segment repeats only a specified number of times, and each repetition is a copy
rather than an instance. Adjustments to the original segment do not alter the shape of its repetitions.
The Duplicate modes are only accessed from the Duplicate contextual menu, which reveals a
submenu with all the looping modes described above. Selecting any of these modes opens a dialog in
which the number of repetitions can be entered.
Gradient Extrapolation

You can choose Gradient Extrapolation by right-clicking in the graph area and choosing it from the contextual menu. This option continues the trajectory of the last two keyframes.

Time Stretching

Time Stretching allows for a selected group of keyframes to be proportionally stretched or squashed. This allows you to change the duration of the animation while keeping the relative distance between each keyframe. To enable spline stretching, select the group of keyframes that you want to time stretch, and then choose Modes > Time Stretching from the graph’s contextual menu or click the Time Stretch button in the toolbar.
When you have more than one keyframe selected on the spline, enabling Time Stretch surrounds the outer keyframes with two vertical white bars. Drag on the white vertical bars to stretch or shrink the timing of the spline segments within the bars. Drag these bars back and forth to stretch or squash the spline segment.

TIP: If no keyframes are selected when you enable Time Stretch, drag a rectangle to set the boundaries of the Time Stretch.

To disable the Time Stretching mode:
- Click on the Time Stretch button in the toolbar again or reselect Modes > Time Stretching from the contextual menu.

Shape Box
The Shape Box transform mode is similar to Time Stretching; however, it can adjust the vertical scaling of keyframe values as well as time.

To enable the Shape Box, do one of the following:
- Select a group of keyframes, and then choose Modes > Shape Box from the contextual menu.
- Select a group of keyframes, and then click the Shape Box button in the toolbar.
- Select a group of keyframes, and then press Shift-B to enable or disable the Shape Box mode.
A white rectangle outlines the selected points when the mode is enabled. To scale, skew, or stretch the spline, drag on any of the control points located around the box. To move all the keyframes, drag on the box edges.

![The Shape Box in the graph](image)

**TIP:** If no points are selected, or if you want to select a new group of keyframes, you can drag out a new rectangle at any time.

**Ease In/Out**

For a more precise way to adjust the length of Bézier direction handles attached to selected keyframes, you can use the Spline Ease dialog. To show the dialog, select a keyframe in the graph, and then choose Edit > Ease In/Out from the graph’s contextual menu or press T on the keyboard.

The Ease In/Out controls appear above the graph area. You can drag over the number fields to adjust the length of the direction handles or enter a value in the fields.

![The Ease In/Out controls above the graph area](image)

Clicking the Lock In/Out button will collapse the two sliders into one, so any adjustments apply to both direction handles.
Importing and Exporting Splines

Spline shapes can be imported and exported from or to an ASCII text file. This makes it easier to save complex spline curves for later reuse, or to transfer tracking, path, and animation data from one application to another. Exported splines are assigned the file extension .spl for easy identification.

To export a spline:
1. Select the active spline in the Spline Editor.
2. Right-click on the spline in the graph area to display the contextual menu.
3. Choose from three format options in the submenu.
4. Enter a name and location in the file browser dialog, and then click Save.

Exporting a spline gives you three options. You can export the Samples, Key Points, or All Points. Samples adds a control point at every frame to create an accurate representation of the spline. Key Points replicates the control point positions and values on the spline using linear interpolation. All Points exports the spline as you see it in the Spline Editor, using the same position, value, and interpolation.

To import a spline:
1. Add an animation spline for the parameter.
2. In the Spline Editor, right-click on the animation spline and select Import Spline from the contextual menu.
3. In the File Browser dialog, select the spline curve .spl file, and then click Open.

Importing a new curve will replace any existing animation on the selected spline.
Chapter 72

Animating with Motion Paths

Layers and 3D objects can move along a designated spline shape to create motion path animations. This chapter discusses how you can create, edit, and use motion paths in Fusion.

Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Animating Using Motion Paths</td>
<td>1258</td>
</tr>
<tr>
<td>Types of Motion Paths</td>
<td>1259</td>
</tr>
<tr>
<td>Polyline Path</td>
<td>1259</td>
</tr>
<tr>
<td>Path Modifier</td>
<td>1262</td>
</tr>
<tr>
<td>Controlling Speed and Orientation along a Path</td>
<td>1263</td>
</tr>
<tr>
<td>XY Path</td>
<td>1265</td>
</tr>
<tr>
<td>Types of Control Points</td>
<td>1267</td>
</tr>
<tr>
<td>Locked Points</td>
<td>1267</td>
</tr>
<tr>
<td>Unlocked Points</td>
<td>1270</td>
</tr>
<tr>
<td>Locking and Unlocking Points</td>
<td>1271</td>
</tr>
<tr>
<td>Tips for Manipulating Motion Paths</td>
<td>1271</td>
</tr>
<tr>
<td>Compound Motion Paths Using Path Centers</td>
<td>1271</td>
</tr>
<tr>
<td>Copying and Pasting Motion Paths</td>
<td>1272</td>
</tr>
<tr>
<td>Removing Motion Paths</td>
<td>1272</td>
</tr>
<tr>
<td>Recording Motion Paths</td>
<td>1273</td>
</tr>
<tr>
<td>Importing and Exporting Polylines</td>
<td>1273</td>
</tr>
<tr>
<td>Native Format</td>
<td>1273</td>
</tr>
</tbody>
</table>
Animating Using Motion Paths

Motion paths are created from splines (polylines) including paint strokes and masks that have a path modifier applied to them. The path modifier defines the movement that transforms ordinary spline shapes into motion paths. You apply the path modifier either explicitly to the Center X/Y or Pivot X/Y parameters or implicitly by keyframing the Center or Pivot parameters. In either case, the spline path is displayed and then visually adjusted in the viewers. For all motion paths, the coordinate control in the viewer represents the position of an object or effect, such as a Transform or Rays node’s center that moves along the path. Coordinate controls are represented onscreen with vertical and horizontal positioning arrows or an X.

The following nodes have parameters that can be animated using path modifiers to move an image around the composition. These include, but are not limited to:

- **Transform**: Center X/Y can be animated to move an image around.
- **DVE**: Center X/Y can be animated to move an image around.
- **Merge**: Center X/Y can be animated to move the Foreground connected image around.
- **Paint**: Stroke Controls > Center X/Y can be animated to move a stroke around.
- **Camera 3D node**: Translation X/Y/Z
- **Shape 3D node**: Translation X/Y/Z

The following nodes have parameters that can be animated using paths to alter the direction of a visual effect. These include, but are not limited to:

- **Directional Blur**: Center X/Y can be animated to change the direction of the blur.
- **Hot Spot**: Primary Center X/Y can be animated to move the hot spot around.
- **Rays**: Center X/Y can be animated to change the angle at which rays are emitted.
- **Polygon/BSpline/Ellipse/Rectangle/Triangle mask**: Center X/Y can be animated to move the mask.
- **Corner Positioner**: Top Left/Top Right/Bottom Left/Bottom Right X/Y can be animated to move each corner of the corner-pinned effect.
- **Vortex**: Center X/Y can be animated to move the center of the warping effect.

**NOTE**: It’s not possible to add a motion path to a one-dimensional value, such as blur strength or merge angle. However, you can use the Spline Editor to edit these kinds of values in a visual way.
Types of Motion Paths

There are three types of motion paths: Polyline paths, XY paths, and 3D motion paths for 3D scenes.

- A Polyline path is generated by applying the path modifier. It uses two splines to define the path; one for the shape of the path displayed in the viewer, and a Displacement spline for the speed of the object along the path, displayed in the Spline Editor. The Polyline path is the default type of path modifier, and most documentation in this chapter assumes that this type is used.

- The XY path modifier employs a spline for the X position of the point and another for the Y position. The XY path modifier is explained in detail later in this chapter.

- 3D motion paths pertain only to positional controls within 3D scenes.

Polyline Path

Polyline paths are the easiest motion paths to work with. You can use the spline shape in the viewer to control the shape of the path, while a single Displacement curve in the Spline Editor is used to control the acceleration along the path. The most obvious way to create a Polyline motion path is by keyframing the Center X/Y parameter of a Transform node in the Inspector.

To create a Polyline motion path using the Center X/Y parameter in the Inspector:

1. Position the playhead on the frame where the motion will begin.
2. In the Inspector, click the gray Keyframe button to the right of the Center X and Y parameters. This action applies the path modifier in the Modifiers tab in the Inspector.
3. Adjust the Center X and Y for the first keyframe position.
4. Position the playhead on the frame where the motion should change or stop.
5. In the Inspector, change the Center X and Y parameters to set a keyframe for the new location automatically.
6. In the viewer, modify and refine the motion path by selecting a control point and using any of the spline controls in the viewer toolbar.
7. Open the Spline Editor and adjust the Displacement spline to control the speed of the object along the path.

Keyframing Center X/Y is not the only way to apply the path modifier. An alternative method is to apply the path modifier to the Center X/Y parameter either in the Inspector or using the coordinate control in the viewer.

To apply a Polyline path to the Center X/Y parameter:

1. Position the playhead on the frame where the motion will begin.
2. Position the center coordinate control for the object, or effect, at its starting position.
3. Right-click the onscreen center coordinate control in the viewer (or over the Center X and Y parameter in the Inspector), and choose Path from the contextual menu for that control.
Applying a path modifier to the center of a Transform node

The object now has a path modifier applied, so without setting a keyframe you can drag the object to begin creating a motion path in the viewer.

4 Move the playhead to a new frame.

5 Drag the onscreen coordinate control or adjust the Offset or Center values in the Inspector. A keyframe is automatically created on the motion path, and a polyline is drawn from the original keyframe to the new one.

6 The position of the center control is interpolated between the two keyframes. You can continue adding points by moving the playhead and adjusting the object’s position until the entire motion path you need is created. For motion paths, there’s no need to close the spline path; you can leave it open.

7 Upon completion, set the polyline to Insert and Modify mode by selecting a point on the path and pressing Command-I or clicking the Insert and Modify button on the toolbar. Don’t worry too much about the overall shape of the motion path at this point. The shape can be refined further by adding additional points to the polyline and modifying the existing points.
A final alternative method for creating a motion path is to draw a spline shape first and then connect a path modifier to the spline. Using any of Fusion's spline tools, you can draw the shape of the path and then connect the path modifier to the published spline. Once the path modifier and the published spline are connected, you can keyframe the Displace parameter to move an image along the path. This method is useful when you want to use a paint stroke or mask shape as a motion path.

**To use a mask shape or paint stroke as a path:**

1. Draw a polygon mask or paint stroke in the shape of the path you want to use.
   
   You do not have to close the mask shape.

2. When done drawing the shape, click the Insert and Modify button in the viewer toolbar to leave the mask shape as an open spline.

3. At this point you can select any of the control points along the spline and press Shift-S to make them smooth or Shift-L to make them linear.

   All mask polylines have animation enabled by default, but that is usually not desirable for a motion path. You will need to remove this keyframe animation if you are using a mask shape.

4. At the bottom of the Inspector, right-click on the “Right-click here for shape animation” label and choose Remove Polygon|Polyline.

5. Right-click at the bottom of the Inspector again and select Publish to give other nodes access to this spline shape. (For a paint stroke, you will need to make the Stroke editable first by clicking the Make Editable button in the Stroke Controls.)
This enables the Modifiers tab with the Published Polyline modifier. This published spline can be used to define the shape of splines in other nodes.

6 Connect a Transform node to the image you want to have follow the path.

7 Right-click over the Center X/Y parameter in the Inspector and choose Path. This adds a path modifier into the Modifiers tab.

8 In the Inspector, click the Modifiers tab and double-click the Path1 heading to open its parameters. The Displacement parameter already has a keyframe on it automatically. You’ll want to remove that so you can set your own.

9 Click the red keyframe button to the right of the Displacement parameter to remove it.

Remove the automatic displacement keyframe prior to creating your own keyframes.

10 At the bottom of the Modifiers tab, right-click on “Right-click here for shape animation” and choose Connect To > Polygon1Polyline.

11 To quickly see where your object has gone, drag the Displacement slider back and forth.

12 You may want to use the Size parameter to adjust the size of the overall path.

The Displacement slider is meant to be keyframed for animating the object along the path.

**Path Modifier**

In terms of functionality, it makes no difference which method you use to generate the path modifier. All the above methods are just different ways to get to the same point. Whichever way you decide to add the path modifier, the Modifiers tab contains controls for the path.
You can use the path modifier controls in the Inspector to change the position, size, and rotation of the entire path shape. The Displacement parameter is represented as a spline in the Spline Editor, which determines the object’s position along the path and the Heading Offset is used for the orientation along the path.

**Controlling Speed and Orientation along a Path**

Every Polyline path has an associated Displacement spline in the Spline Editor. The Displacement spline represents acceleration, or the position of the animated object along its path, represented as a value between 0.0 and 1.0.

The Displacement curve of a Poly path represents the acceleration of an object on a path.

Smaller values are closer to the beginning of a path, while larger values are increasingly closer to the end of the path.

For instance, let’s say you have a bumblebee that bobs up and down as it moves across the screen. To have the bee accelerate as it moves up and down but slow down as it reaches its peaks and valleys you use the Displacement curve.

The curved shape path does not define how fast the bee moves. The speed of the bee at any point along the path is a function of the Displacement parameter. You can control the Displacement parameter either in the Modifiers tab or in the Spline Editor.
To use the Displacement parameter to control the speed of an object on a path, do the following.

1. Position the playhead at the start of the animation.
2. In the Modifiers tab, drag the Displacement parameter to 0.0. This positions the object at the start of the path.
3. Click the Keyframe button to the right of the Displacement parameter.
4. Position the playhead somewhere further into the comp and drag the Displacement parameter until the object is where you want it to be based on the current frame.
5. Continue updating the playhead and the Displacement parameters at key points in the comp until you have reached the end of the path.

After the initial animation is set, you can use the Displacement curve in the Spline Editor to adjust the timing.

To adjust the timing of an object along a path:

1. Open the Spline Editor and enable the Displacement spline in the header.
2. Move control points horizontally closer together to increase the speed between the two points while maintaining the location of the object along the path.
   A longer, flatter curve between two points indicates a slower rate of change.
3. Drag a control point up or down to change its location on the path while maintaining the timing between two points.

A Displacement curve in the Spline Editor

**TIP:** Holding down the Option key while clicking on the spline path in the viewer will add a new point to the spline path without adding a Displacement keyframe in the Spline Editor. This allows you to refine the shape of the path without changing the speed along the path.

Using a Path Modifier to Adjust Orientation

The Heading parameter is used to adjust the orientation of the object along the path. For instance, if you want the bee in our animation to auto-orient based on the direction of the path, you can connect the bee’s angle to the Heading parameter.

To connect the Heading to an object's angle:

1. Right-click over an object’s angle parameter in a Transform node.
2. Choose Connect To > Path > Header.
In our example comp, the bee now auto-orient as the path descends and rises.

The Transform’s angle parameter connected to the path modifier's Heading parameter

**XY Path**

Unlike a Polyline path, the XY path modifier uses separate splines in the Spline Editor to calculate position along the X-axis and along the Y-axis.

**To animate a coordinate control using an XY path modifier:**
- Right-click on the center coordinate control in the viewer or the Center X/ Y parameter in the Inspector, and then choose Modify With > XY Path from the contextual menu.

At first glance, XY paths work like Polyline paths. To create the path once the modifier is applied, position the playhead and drag the onscreen control where you want it. Position the playhead again and move the onscreen control to its new position. The difference is that the control points are only there for spatial positioning. There is no Displacement parameter for controlling temporal positioning.
Instead of dragging in the viewer, you can use the controls in the Modifiers tab to create a motion path, while using the object's original Inspector controls as an offset to this motion path. You can use the XYZ parameters to position the object, the Center X/Y parameters to position the entire path, the Size and Angle to scale and rotate the path, and the Heading Offset control to adjust the orientation.

Using an XY path modifier to animate a piece of text

Using the XY Paths in the Spline Editor

The Spline Editor for the XY path displays the X and Y channel splines. Changes to the path in the viewer or the Inspector will be displayed as keyframes on these splines in the Spline Editor. Unlike a Polyline path, XY paths do not include a Displacement curve. The speed of the object along the path is tied to the path itself and cannot be separated from the timing of the keyframes that define that path.

**TIP:** XY path and Poly path can be converted between each other from the contextual menu. This gives you the ability to change methods to suit your current needs without having to redo animation.

The advantage of the XY path modifier is that you can explicitly set an XY coordinate at a specific time for more control.
XY Path displays X and Y curves in the Spline Editor but does not include a Displacement control.

Switching Default Paths

If you want to change the default path type to XY path, you can choose Fusion > Preferences > Globals in Fusion Studio or Fusion > Fusion Settings in DaVinci Resolve. In the Settings window, select the Defaults category and choose XY Path for the Points With drop-down menu. The next time you keyframe the Center X/Y parameter or choose Animate from CenterX/Y’s contextual menu, an XY path modifier will be used instead of a Polyline path.

Types of Control Points

The control points along an XY path in the viewer are locked to the control points on the X and Y curve in the Spline Editor. The number of points are identical, and adding a control point in one place adds it to the other. That is not the case with a Polyline path. Polyline paths are composed of locked and unlocked points. Whether a point is locked is determined by how it was added to the Polyline. Locked points on the motion path in the viewer will have an associated point on the Displacement spline in the Spline Editor; unlocked points will not have corresponding points. Each has a distinct behavior, as described below.

Locked Points

Locked points are the motion path equivalents of keyframes. They are created by changing the playhead position and moving the animated control. These points indicate that the animated control must be in the specified position at the specified frame.

The locked points are displayed as larger-sized hollow squares in the viewer. Each locked key has an associated point on the path’s Displacement curve in the Spline Editor.

Deleting a locked point from the motion path will change the overall timing of the motion.
To change the duration of a path using locked points:

1. Connect an object to a Transform node.
2. Position the where you want to start the motion path.
3. Set the playhead at frame 0.
4. Select the Transform node and in the Inspector, click the Keyframe button to the right of the Center X/Y parameter.
   
   This adds the path modifier and creates the first locked point of the path.
5. Position the playhead at frame 45.
6. Move the object’s center to the lower center of the screen.
7. View the Spline Editor and display Path1’s Displacement spline.

A graphic placed on the right side of the frame

Moving the playhead and repositioning the bee adds a second locked point

This sets the second locked point.
At a value of 0.0, the control will be located at the beginning of the path. When the value of the Displacement spline is 1.0, the control is located at the end of the path.

8 Select the keyframe at frame 45 in the Displacement spline and drag it to frame 50. The motion path is now 50 frames long, without making any changes to the motion path’s shape. If you try to change this point’s value from 1.0 to 0.75, it cannot be done because the point is the last in the animation, so the value must be 1.0 in the Displacement spline.

9 Position the playhead on frame 100 and move the bee center to the upper-left corner of the screen.

Moving locked points changes the duration of a motion path without changing its shape.

This will create an additional locked point and set a new ending for the path.
Unlocked Points

Unlocked points are created when additional points are added to the motion path while in Insert and Modify modes. These points are used to adjust the overall shape of the motion path, without directly affecting the timing of the motion. This means you can add whatever unlocked points you want to reshape a motion path, without that having any effect on the timing of the animation on that path. This makes it vastly easier to fine-tune a motion path spatially after you’ve perfected the timing of the animation temporally.

Unlocked points do not have corresponding points on the path’s Displacement spline. They appear in the viewer as smaller, solid square points.

To add unlocked points to a motion path, do the following:

1. Select a motion path spline by using the Tab key to cycle controls until the path is selected.
2. To insert points along a path, click the Insert and Modify button in the toolbar.
3. Click on the path and create two new points: one half-way between the first and the second points, and the other half-way between the second and the third points.

The two points just added are not present in the motion path’s Displacement spline. These are unlocked points, used to shape the motion but unrelated to the timing of the path.

You can add unlocked points to the Displacement spline as well. Additional unlocked points in the Spline Editor can be used to make the object’s motion pause briefly.

To pause motion along a motion path using an unlocked point:

- Select a locked point on the Displacement spline and then hold down the Command key while dragging the point horizontally to another frame. The point is copied as an unlocked point to the new frame.
Create a pause in the motion by copying locked points

Knowing the difference between locked and unlocked points gives you independent control over the spatial and temporal aspects of motion paths.

**Locking and Unlocking Points**

You can change an unlocked point into a locked point, and vice versa, by selecting the point(s) and choosing the Lock Point option from the contextual menu.

**Tips for Manipulating Motion Paths**

There are a variety of ways you can create and edit motion paths in the viewer.

**Compound Motion Paths Using Path Centers**

Every motion path has a defined center represented by a crosshair. Path centers allow paths to be connected to other controls and behave in a hierarchical manner, which is an exceptionally powerful way of creating complex motion by combining relatively simple paths.

A useful example of this technique would be animating the path of a bee in flight. A bee often flies in a constant figure eight pattern while simultaneously moving forward. The easy way of making this happen involves two paths working together.

In the following example, the bee would be connected to a first path in a Transform node, which would be a figure eight of the bee moving in place. This first path’s center would then be connected to another path defining the forward motion of the bee through the scene via a second Transform node.

**To create a compound motion path:**

1. Create a figure-eight motion path by keyframing an object or drawing a polyline mask.
   (If using a polygon mask, you’ll need to remove the auto-keyframing and publish the mask prior to the next step.)
2. Add a polyline mask and create a smooth curve spline that travels across the screen.
3. At the bottom of the Inspector, right-click over the "Right-click here for shape animation" label and choose Remove Polygon Polyline to remove the auto-animation behavior.
4. Right-click over the label again and choose Publish.
5. Select the object’s Transform node and click the Modifiers tab.
6. Right-click over the Path1 Center X/Y parameter and choose Path.
7. At the bottom of Path2, choose Connect To > Polygon: Polyline.
8. Keyframe the Path2 Displacement to move the object along the second path.
Copying and Pasting Motion Paths

It is possible to copy an entire motion path to the clipboard and then paste it onto another node or path or composition.

Methods of copying and pasting motion paths:

- **To copy a motion path:** In the Inspector’s Modifiers tab, right-click on the path’s control header and choose Copy from the contextual menu.

- **To cut a motion path out of a node:** In the Inspector, right-click on the path’s control header and choose Cut from the contextual menu.

- **To paste the copied path over another path:** In the Inspector, right-click on the path’s control header and choose Paste from the contextual menu.

When pasting a path, the old motion path will be overwritten with the one from the clipboard.

Removing Motion Paths

There are multiple ways to remove or delete a path, and they all involve a right-click contextual menu. Removing a path modifier does not remove the object or the spline shape; it only removes the animation from the object and the modifier from the Modifiers tab in the Inspector.

**To remove a path, do one of the following:**

- In the Modifiers tab, right-click over the Path1 header and choose Delete from the menu.

- In the Inspector, right-click over the Center XY parameter and choose Remove Path1 from the menu.

- Right-click the center coordinate control in the viewer for the object you’re animating, and choose Remove Path1 from the submenu of the NameOfObject; Center submenu.

Removing an entire motion path at once
Recording Motion Paths

You can animate both of the control’s spatial and temporal information at the same time using the Record mode. This is useful when both position and speed are crucial to achieve the desired result.

Right-click on the desired path and select Record from the contextual menu. This displays a submenu of available data that may be recorded.

Use the Record Time option in conjunction with the Draw Append mode to create complex motion paths that will recreate the motion precisely as the path is drawn.

The time used to record the animation may not suit the needs of a project precisely. Adjust the path’s Displacement spline in the Spline Editor to more correctly match the required motion.

Importing and Exporting Polylines

You can import and export polyline shapes into a common editable ASCII text file or its native format. These methods are used to save a particularly useful or generic mask or path for future use or for use in another application, such as Maya or LightWave. You can also import FXF, SSF, or Nuke shape files.

Native Format

To save a polyline shape in Fusion’s native ASCII format, right-click on the header of the Mask node in the Inspector and select Settings > Save As from the contextual menu. Provide a name and path for the saved file and select OK to write a file with the .setting extension. This file will save the shape of a mask or path, as well as any animation splines applied to its points or controls.

To load the saved setting back into Fusion, you first create a new polyline of the same type, and then select Settings > Load from the mask’s context menu or drag the .setting file directly into the Node Editor.

If you want to move a polyline from one composition to another, you can also copy the node to the clipboard, open your second composition, and paste it from the clipboard into the new composition.
Some of the most powerful aspects of Fusion are the different ways it allows you to go beyond the standard tools delivered with the application. This chapter provides an introduction to a variety of advanced features, including Modifiers, Expressions, and Scripting, which can help you extend the functionality and better integrate Fusion into your studio.

Contents

The Contextual Menu for Parameters in the Inspector 1275
Using Modifiers 1275
Adding the Right Modifier for the Job 1275
Adding Modifiers to Individual Parameters 1275
Combining Modifiers and Keyframes 1276
Publishing a Parameter 1276
Connecting Multiple Parameters to One Modifier 1277
Adding and Inserting Multiple Modifiers 1277
Performing Calculations in Parameter Fields 1278
Using SimpleExpressions 1278
Pick Whipping to Create an Expression 1281
Removing SimpleExpressions 1281
Customizing User Controls 1281
FusionScript 1285
The Contextual Menu for Parameters in the Inspector

Most of the features in this chapter are accessed via a contextual menu that appears when you right-click most parameters in the Inspector. Different contextual menus are available based on where in the Inspector you right-click. Specifically, right-clicking over parameter names or sliders displays a feature-rich contextual menu that can add animation, expression fields, modifiers to extend functionality, as well as publishing and linking capabilities, allowing you to adjust multiple controls simultaneously.

Using Modifiers

Parameters can be controlled with modifiers, which are extensions to a node's toolset. Many modifiers can automatically create animation that would be difficult to achieve manually. Modifiers can be as simple as keyframe animation or linking the parameters to other nodes, or modifiers can be complex expressions, procedural functions, external data, third-party plug-ins, or fuses.

Adding the Right Modifier for the Job

Which modifiers are available depends on the type of parameter you’re right-clicking over. Numeric values, text, polylines, gradients, and points each have different sets of modifiers that will work with them, so the Modify With menu is filtered based on each parameter.

Adding Modifiers to Individual Parameters

You add modifiers to a parameter using the Inspector’s contextual menu, or by right-clicking the onscreen control for a parameter in the viewer. Either way, a dynamic list of modifiers that are appropriate for the selected parameters is displayed. For instance, a Perturb modifier can be added to any slider to auto-animate the parameter by randomly wiggling the value. Once the modifier is added, controls are displayed in the Modifiers tab to adjust the speed and amplitude of the random animation.

A modifier’s controls are displayed in the Modifiers tab of the Inspector. When a selected node has a modifier applied, the Modifiers tab will become highlighted as an indication. The tab remains grayed out if no modifier is applied.
Modifiers appear with header bars and header controls just like the tools for nodes. A modifier’s title bar can also be dragged into a viewer to see its output.

**Combining Modifiers and Keyframes**

Modifiers that auto-animate parameters like Perturb and Shake can be combined with keyframes to create more natural, organic looking animations. For instance, you can create the general motion path for an element by keyframing the Center X and Y parameters, and then apply a modifier to the same parameters to create a secondary wiggling motion.

**To combine a keyframed motion path with a Perturb modifier:**
1. Add a Transform to an image like a butterfly or spaceship.
2. Select the Transform node in the Node Editor.
3. In the Inspector, click the Keyframe button to the right of the Center X and Y parameters.
4. Position the butterfly or spaceship image where you want the start of the animation to begin.
5. Continue to move the playhead in the render range and reposition the image until you create a figure-8 motion path.
6. Right-click over the Center X label in the Inspector and choose Modify With > Perturb.
7. Click the Modifiers tab at the top of the Inspector and adjust random, wiggling motion by setting the Strength, Wobble, and Speed parameters while the animation plays.

**Publishing a Parameter**

The Publish modifier makes the value of a parameter available, so that other parameters can connect to it. This allows you to simultaneously use one slider to adjust other parameters on the same or different nodes. For instance, publishing a motion path allows you to connect multiple objects to the same path.
Once a parameter is published, you can right-click another parameter and choose Connect To > [published parameter name] from the contextual menu. The two values are linked, and changing the parameter value of one in the Modifiers tab changes the other.

Using the pick whip between two parameters provides similar linking behavior with more flexibility. Pick whipping between parameters is covered later in this chapter.

**Connecting Multiple Parameters to One Modifier**

A single modifier or published parameter can be applied to multiple parameters so they all act as one. This is handled through the Connect To submenu. As with modifier assignment, the list is filtered to show only options that are suitable for the parameter you’ve right-clicked on. When you do this, the connection is bidirectional; editing either parameter will cause the other parameter to change.

[Image: The Connect To menu connects modifiers to multiple parameters]

**Adding and Inserting Multiple Modifiers**

Modifiers can be connected to each other and branched, just like nodes in the Node Editor. For example, the Calculation modifier outputs a number, but has two Number parameters, both of which can have modifiers added to them. If you want to insert a modifier between the existing modifier and the modified parameter, use the Insert submenu of the parameter’s contextual menu.

**Available Modifiers in Fusion:**

- **Bézier Spline:** Adds a Bézier spline to the Spline Editor for animating the selected parameter.
- **B-Spline Spline:** Adds a B-Spline spline to the Spline Editor for animating the selected parameter.
- **Calculation:** Creates an indirect link that includes a mathematical expression between two parameters.
- **CoordTransform Position:** Calculates the current 3D position of a given object even after multiple 3D transforms have repositioned the object through the node tree hierarchy.
- **Cubic Spline:** Adds a Cubic spline to the Spline Editor for animating the selected parameter.
- **Expression:** Allows you to add a variable or a mathematical calculation to a parameter, rather than a straight numeric value. The Expression modifier provides controls in the Modifiers tab, giving you more room and parameters than the SimpleExpression.
- **From Image:** This modifier takes color samples of an image along a user-definable line and creates a gradient from those samples.
- **Gradient Color Modifier:** Creates a customized gradient and maps it into a specified time range to animate a value.
- **KeyStretcher:** Used to stretch keyframes in a Fusion Title template when trimming the template in the Edit page or Cut page timeline.
- **MIDI Extractor:** Modifies the value of a parameter using the values stored in a MIDI file.
- **Natural Cubic Spline:** Adds a Natural Cubic spline to the Spline Editor for animating the selected parameter.
– **Offset (Angle, Distance, Position):** The three Offset modifiers are used to create variances, or offsets, between two positional values. For instance, when this modifier is added to a size parameter, you can change the size of an object using the distance between two onscreen controls (position and offset).

– **Path:** Produces two splines to control the animation of an object: An onscreen motion path (spacial) and a Time spline visible in the Spline Editor (temporal).

– **Perturb:** Generates smoothly varying random animation for a given parameter.

– **Probe:** Auto-animates a parameter by sampling the color or luminosity of a specific pixel or rectangular region of an image.

– **Publish:** The first step in linking two non-animated parameters is to use the Publish modifier to publish a parameter. That allows other parameters to use the Connect To submenu and link to the published parameter.

– **Shake:** Similar to Perturb, Shake generates smoothly varying random animation for a given parameter.

– **Track:** Attaches a single point tracker to the selected parameter. The tracker can then track an object onscreen to animate the parameter. This is quicker and more direct than using the normal Tracker node; however, it offers less flexibility since the resulting tracker is only a single point and can only be used for the selected parameter.

– **Vector Result:** Similar to the Offset modifier, Vector Result is used to offset position parameters using origin, distance, and angle controls to create a vector. This vector can then be used to adjust any other parameter.

– **XY Path:** Produces an X and Y spline in the Spline Editor to animate the position of an object.

For more information on all modifiers available in Fusion, see Chapter 122, “Modifiers.” In the DaVinci Resolve Reference Manual and Chapter 61 in the Fusion Reference Manual.

**Performing Calculations in Parameter Fields**

You can enter simple mathematical equations directly in a number field to calculate a desired value. For example, typing 2.0 + 4.0 in most number fields will result in a value of 6.0. This can be helpful when you want a parameter to be the sum of two other parameters or a fraction of the screen resolution.

**Using SimpleExpressions**

Simple Expressions are a special type of script that can be placed alongside the parameter it is controlling. These are useful for setting simple calculations, building unidirectional parameter connections, or a combination of both. You add a SimpleExpression by entering an equals sign directly in the number field of the parameter and then pressing Return.

![Image of a parameter field with a SimpleExpression]

Entering an equals sign opens the SimpleExpression field with Pick Whip control.
An empty field will appear below the parameter, and a yellow indicator will appear to the left. The current value of the parameter will be entered into the number field. Using Simple Expressions, you can enter a mathematical formula that drives the value of a parameter or even links two different parameters. This helps when you want to create an animation that is too difficult or impossible to set up with keyframing. For instance, to create a pulsating object, you can use the sine and time functions on a Size parameter. Dividing the time function can slow down the pulsing while multiplying it can increase the rate.

![A SimpleExpression using the sine and time functions](image)

Inside the SimpleExpression text box, you can enter one-line scripts in Lua with some Fusion-specific shorthand. Some examples of Simple Expressions and their syntax include:

<table>
<thead>
<tr>
<th>Expression</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>time</td>
<td>This returns the current frame number.</td>
</tr>
<tr>
<td>Merge1.Blend</td>
<td>This returns the value of another input, Blend, from another node, Merge1.</td>
</tr>
<tr>
<td>Merge1:GetValue(“Blend”, time-5)</td>
<td>This returns the value from another input, but sampled at a different frame, in this case five frames before the current one.</td>
</tr>
<tr>
<td>sin(time/20)/2+.5</td>
<td>This returns a sine wave between 0 and 1.</td>
</tr>
<tr>
<td>iif(Merge1.Blend == 0, 0, 1)</td>
<td>This returns 0 if the Blend value is 0, and returns 1 if it is not. The iif() function is a shorthand conditional statement, if-then-else.</td>
</tr>
<tr>
<td>iif(Input.Metadata.ColorSpaceID == “sRGB”, 0, 1)</td>
<td>This returns 0 if the image connected to the current node’s Input is tagged with the sRGB colorspace. When no other node name is supplied, the expression assumes the Input is coming from the current node. It is equivalent to self.Input. The Input in most, but not all, Fusion nodes is the main image input shown in the Node Editor as an orange triangle. Images have members that you can read, such as Depth, Width, Metadata, and so on.</td>
</tr>
<tr>
<td>Point(Text1.Center.X, Text1.Center.Y-.1)</td>
<td>Unlike the previous examples, this returns a Point, not a Number. Point inputs use two members, X and Y. In this example, the Point returned is 1/10 of the image height below the Text1’s Center. This can be useful for making unidirectional parameter links, like offsetting one Text from another.</td>
</tr>
<tr>
<td>Text1.Center - Point(0,.1)</td>
<td>This is similar to the previous expression. This SimpleExpression returns Text instead of a Number or Point.</td>
</tr>
<tr>
<td>Expression</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Text(“Colorspace: ..(Merge1.Background.Metadata.ColorSpaceID)</td>
<td>The string inside the quotes is concatenated with the metadata string, perhaps returning:</td>
</tr>
<tr>
<td></td>
<td><strong>Colorspace: sRGB</strong></td>
</tr>
<tr>
<td>Text(“Rendered ..os.date(“%b %d, %Y”)..” at ..os.date(“%H:%M”)..”\n on the computer ..os.getenv(“COMPUTERNAME”)..” running ..os.getenv(“OS”)..”\n from the comp ..ToUNC(comp.Filename))</td>
<td>This returns a much larger Text, perhaps something like:</td>
</tr>
<tr>
<td></td>
<td><strong>Rendered Nov 12, 2019 at 15:43 on the computer Rn309 running Windows_NT from the comp \SRVR\Proj\Am109\SlateGenerator_A01.comp</strong></td>
</tr>
<tr>
<td>os.date(“%H:%M”)</td>
<td>The OS library can pull various information about the computer. In the previous example, os.date gets the date and time in hours:minutes.</td>
</tr>
<tr>
<td>“..os.getenv(“COMPUTERNAME”)..” running “..os.</td>
<td>Any environment variable can be read by os.getenv, in this case the computer name and the operating system.</td>
</tr>
<tr>
<td>“\n from the comp ..ToUNC(comp.Filename)</td>
<td>To get a new line in the Text, \n is used. Various attributes from the comp can be accessed with the comp variable, like the filename, expressed as a UNC path.</td>
</tr>
</tbody>
</table>

**TIP:** When working with long SimpleExpressions, it may be helpful to drag the Inspector panel out to make it wider or to copy/paste from a text editor or the Console.

After setting an expression that generates animation, you can open the Spline Editor to view the values plotted out over time. This is a good way to check how your SimpleExpression evaluates over time.

![A sine wave in the Spline Editor, generated by the expression used for Text1: Size](image)

For more information about writing Simple Expressions, see the Fusion Studio Scripting Guide, and the official Lua documentation.
Pick Whipping to Create an Expression

With a SimpleExpression field open, a + button is displayed on the left side. Dragging the + button onto another control, or “pick whipping,” links the two parameters, similar to the Connect To menu. However, unlike a Connect To parameter link, the pick whip allows you to modify the connection by further editing the expression.

SimpleExpressions can also be created and edited within the Spline Editor. Right-click on the parameter in the Spline Editor and select Set Expression from the contextual menu. The SimpleExpression will be plotted in the Spline Editor, allowing you to see the result over time.

Removing SimpleExpressions

To remove a SimpleExpression, right-click the name of the parameter, and choose Remove Expression from the contextual menu.

Customizing User Controls

Each tool’s parameters are organized in a logical order in the Inspector. The most used controls are closer to the top, and the more subtle refinement controls are lower in the list. Sometimes, though, you may want to add, hide, or change the controls. You often need to do this for SimpleExpressions and macros, but you may also do this for usability and aesthetic reasons for favorites and presets.

Custom controls can be added or edited via the Edit Control dialog, which you access by right-clicking over the node’s name in the Inspector and choosing Edit Controls from the menu.
In the Edit Control dialog, you use the ID menu to select an existing parameter or create a new one. You can name the control and define whether it is a text field, number field, or a point using the Type attributes list.

You use the page list to assign the new control to one of the tabs in the Inspector. There are also settings to determine the defaults and ranges, and whether it has an onscreen preview control. The Input Ctrl box contains settings specific to the selected Type, and the View Ctrl attributes box contains a list of onscreen preview controls to be displayed, if any.

All changes made using the Edit Controls dialog get stored in the current tool instance, so they can be copied/pasted to other nodes in the comp. However, to keep these changes for other comps, you must save the node settings, and add them to the Bins in Fusion Studio or to your favorites.

As an example, we’ll customize the controls for a DirectionalBlur:

Let’s say we wanted a more interactive way of controlling a linear blur in the viewer, rather than using the Length and Angle sliders in the Inspector. Using a SimpleExpression, we’ll control the length and angle parameters with the Center parameter’s onscreen control in the viewer. The SimpleExpression would look something like this:
For Length:
\[ \sqrt{((\text{Center}.X-.5)\times(\text{self}.\text{Input}.\text{XScale}))^2+((\text{Center}.Y-.5)\times(\text{self}.\text{Input}.\text{YScale})\times(\text{self}.\text{Input}.\text{Height}/\text{self}.\text{Input}.\text{Width}))^2} \]

For Angle:
\[ \text{atan2}(0.5-\text{Center}.Y, 0.5-\text{Center}.X) \times 180 / \pi \]

DirectionalBlur controlled by the Center’s position.

This admittedly somewhat advanced function does the job fine. Dragging the onscreen control adjusts the angle and length for the directional blur. However, now the names of the parameters are confusing. The Center parameter doesn’t function as the center anymore. It is the direction and length of the blur. It should be named “Blur Vector” instead. You no longer need to edit the Length and Angle controls, so they should be hidden away, and since this is only for a linear blur, we don’t need the Type menu to include Radial or Zoom. We only need to choose between Linear and Centered. These changes can easily be made in the Edit Controls dialog.

To change the Inspector parameters for the example above:
1. In the Edit Control dialog, select the Center from the ID list.
2. A dialog will appear asking if you would like to Replace, Hide, or Change ID. We’ll choose Replace.
3. Change the Name to Blur Vector.
4. Set the Type to Point.
5. Select Controls in the Page list. (Controls is the first tab in the Inspector, normally.)
6. Click OK.

DirectionalBlur Center parameter name changed to Blur Vector.
The new Blur Vector parameter now appears in the Inspector. The internal ID of the control is still Center, so our SimpleExpressions did not change.

**To hide the Length and Angle parameters in the Inspector:**
1. In the Edit Control dialog, select the Length from the ID list.
2. Select Controls from the Page list.
3. In the input Ctrl list, select Node.
4. Click OK.
5. In the Edit Control dialog, select the Angle from the ID list.
6. In the input Ctrl list, select Node.
7. Click OK.

**Finally, to remove Radial and Zoom options from the Type menu:**
1. In the Edit Control dialog, select the Type from the ID list.
2. Select Controls from the Page list.
3. Select Radial from the Items list and click Del to remove it.
4. Select Zoom from the Items list and click Del to remove it.
5. Click OK.

The Type menu now includes only two options.

If you want to replace the Type menu with a new checkbox control, you can do that by creating a new control and a very short expression.

**To create a new control:**
1. In the Edit Control dialog, enter Center Blur in the Name field.
2. Select the New Control from the ID list.
3. Set the Type to Number, and set the Page to Controls.
4. Set the Input Ctrl to CheckboxControl.
5. Click OK.

To make this new checkbox affect the original Type menu, you’ll need to add a SimpleExpression to the Type:

\[ \text{iif(TypeNew==0, 0, 2)} \]

The “iif” operator is known as a conditional expression in Lua script. It evaluates something based on a condition being true or false.
FusionScript

Scripting is an essential means of increasing productivity. Scripts can create new capabilities or automate repetitive tasks, especially those specific to your projects and workflows. Inside Fusion, scripts can rearrange nodes in a comp, manage caches, and generate multiple output files for delivery. They can connect Fusion with other apps to log artist time, send emails, or update webpages and databases.

FusionScript is the blanket term for the scripting environment in Fusion. It includes support for Lua as well as Python 2 and 3 for some contexts. FusionScript also includes libraries to make certain common tasks easier to do with Lua and Python within Fusion.

You can run interactive scripts in various situations. Common scripts include:

– Utility Scripts, using the Fusion application context, are found under the File > Scripts menu.
– Comp Scripts, using the composition context, are found under the Script menu or entered into the Console.
– Tool Scripts, using the tool context, are found in the Tool’s context menu > Scripts.

Other script types are available as well, such as Startup Scripts, Scriptlibs, Bin Scripts, Event Suites, Hotkey Scripts, Intool Scripts, and SimpleExpressions. Fusion Studio allows external and command-line scripting as well and network rendering Job and Render node scripting.

FusionScript also forms the basis for Fuses and ViewShaders, which are special scripting-based plug-ins for tools and viewers that can be used in both Fusion and Fusion Studio.

For more information about scripting, see the Fusion Scripting Documentation, accessible from the Documentation submenu of the Help menu.
This chapter covers the bin system in Fusion Studio. Bins allow for the storage and organization of clips, compositions, tool settings, and macros, similar to the Media Pool and Effects Library in DaVinci Resolve. It includes a built-in Studio Player for creating a playlist of multiple shots and their versions. Bins can be used in a server configuration for organizing shots and collaborating with other team members across the studio.

Contents

Bins Overview 1287
Bins Interface 1287
Viewing and Sorting Bins 1288
Organizing Bins 1289
Adding and Using Content 1291
File Type Details 1292
Using Content from Bins 1292
Jog and Shuttle 1293
Stamp Files 1293
Using the Studio Player 1294
Playing a Single Clip 1294
Creating a Reel 1295
Connecting Bins Over a Network 1302
Adding a Remote Bin Entry 1303
Accessing Remote Bins 1304
Permissions 1304
Studio Player and Bin Server 1304
Bins Overview

Bins are folders that provide an easy way of accessing commonly used tools, settings, macros, compositions, and footage. They can keep all your custom content and resources close at hand, so you can use them without searching through your hard drives. Bins can also be shared over a network to improve a collaborative workflow with other Fusion artists.

Bins are only available in Fusion Studio.

Bins Interface

The Bins window is separated into two panels. The sidebar on the left is a list of the bins, while the Content panel on the right displays the selected bin’s contents.

To open the Bins window, do one of the following:
- Choose File > Bins from the menu bar.
- Press Command-B.
TIP: When opening the Bins window on macOS, the window may open behind the current Fusion Studio window. Check in the dock for the Bins window icon or move the Fusion Studio window to locate the Bins window if you are working on a single monitor.

The sidebar organizes content into bins, or folders, using a hierarchical list view. These folders can be organized however they suit your workflow, but standard folders are provided for Clips, Compositions, Favorites, Projects, Reels, Settings, Templates, and Tools. The Tools category is a duplicate of all the tools found in the Effects library. The Tools bin is a parent folder, and parent folders contain subfolders that hold the content. For instance, Blurs is a subfolder of the Tools parent folder. Parent folders can be identified by the disclosure arrow to the left of their name.

When you select a folder from the sidebar, the contents of the folder are displayed in the Contents panel as thumbnail icons.

Viewing and Sorting Bins

A contextual menu is used to access most of a bin’s features. You show the contextual menu by right-clicking in an empty area in the Contents panel. Right-clicking on an item will show the same menu with additional options for renaming, playing, or deleting the item.

Icon or List View

One use of the contextual menu is to switch between viewing the contents as thumbnail icons or as a list.

To view a bin’s contents in List view:

1. Right-click in an empty area of the Contents panel.
2. From the contextual menu, choose View > Details.

Each bin in the sidebar can be set to List view or Icon view independently of each other. So while you may have some bins you want to see as a list, others may be easier to view as icons.
The Bins List view

Sort Order in List View

Clicking on the heading of a column in List view will sort the list in ascending order, and clicking it again will reverse the sort order.

Icon Size in Icon View

The icons can be adjusted to small, medium, large, or huge by clicking the Size button in the bottom toolbar or right-clicking in an empty area of the Contents panel to bring up the contextual menu and choosing a size from the Icon Size submenu.

Use the Size button to select the icon size in the bin

Organizing Bins

Once you begin adding your own categories and content, you can have hundreds of items that need to be organized. To keep all of your elements accessible, you'll want to use some basic organization, just like keeping files and documents organized on your computer.

To create a new folder in the sidebar:

1. In the sidebar, select the parent folder under which the new folder will be listed.
2. Right-click in an empty area of the Contents panel.
3. From the contextual menu, choose New > New Folder.
4. Enter a name for the new folder, and then click OK on the dialog.
You can also click the New Folder icon in the toolbar.

**To rename a bin folder:**
1. Right-click on the folder icon in the Contents panel.
2. Choose Rename from the contextual menu or press F2 on the keyboard.

**To move a folder into or out of a parent folder:**
1. Select the parent folder that contains the folder you want to move.
2. In the Contents panel, drag the folder into the sidebar where you want it moved.

When you drag a folder onto another folder in the sidebar, you create a hierarchical subfolder. Dragging it to the Library parent folder at the top of the sidebar will add it to the top level of the Bins window.

**To remove a folder from the bins:**
1. Select the folder in the Contents panel.
2. Press Command-Delete (Backspace on Windows and Linux).

**Tip:** You cannot undo removing a folder from the Bins window.
Adding and Using Content

You can add and use different types of content with bins. Fusion Studio compositions, tools, saved tool settings, macros, tool groups, and any file format that is supported in Fusion can be added to bins and then used in compositions at a later time.

**To add an item to a bin:**
1. Select a bin in the sidebar where you want to add the content.
2. Right-click in the Contents panel.
3. Choose New > … from the contextual menu.
4. Select the media, settings, macros, or comps in the file browser, and then click Open.

**To remove an item from the bins:**
1. Select the folder in the Contents panel.
2. Right-click on the item and choose Delete from the contextual menu or press Command-Delete.

**TIP:** Unsupported files like PDFs can also be saved in the bin, and the application that supports it will launch when you double-click the file. It’s a useful location for scripts and notes.

If you have an operating system file browser window open, you can drag files directly into a bin as well. When adding an item to the bins, the files are not copied. A link is created between the content and the bins, but the files remain in their original location.
File Type Details
Some types of content have additional methods of being added to bins. Some additional methods are because of the file type and some are because of where they are located.

Projects and Media
In addition to using the New… contextual menu as explained earlier, Fusion Studio project files with the extension “.comp” and media can also be added to bins by dragging them to the Contents panel from a file browser.

Tool Settings
If you want to add a node with custom settings to a bin, first save the node as a setting by right-clicking over it in the Node Editor and choosing Settings > Save As. Once the setting is saved, you can add it to a bin by dragging it from a File Browser into the Bins window.

Image Sequences and Stills
Image sequences are automatically identified on disk and loaded as clips rather than stills, so it is not necessary to select more than one frame from an image sequence when dragging it into a bin.

To ignore the image sequence and import only a single frame, hold Shift when you drag the frame into a bin. This can be useful when trying to import a single still image from a series of still shots with a DSLR. The numbers maybe sequential, but you just need one still image from the series.

Using Content from Bins
Once you have content in your bins, you’ll want to add them to a composition. In general, you can either drag the content directly into the Node Editor or double-click it to add it; however, each type of content behaves a little differently when added to the Node Editor.

Media
Dragging media into the Node Editor from a bin window creates a new Loader that points to the media on disk. Still files or photos are automatically set to loop.

Compositions
To add a composition, you must right-click and choose Open. Dragging a comp item onto an open composition will have no effect. When a composition is added, it is opened in a new window. It is not added to the existing composition.

Tools, Tool Settings, and Macros
When you add tools from the Tools categories to a composition, the methods you use and results you get are similar to adding tools using the toolbar buttons or the Effects Library. Dragging a tool allows you to place it anywhere in the Node Editor, unconnected, or, if you drag it over a connection line, inserted between two existing tools. Double-clicking a tool in the bin will insert it after the Active tool in the Node Editor. Dragging a tool from a bin into a viewer will insert that tool after the currently viewed tool.

Settings and macros work a bit differently than tools. They can only be added to the Node Editor by dragging and dropping. Dragging a setting or macro allows you to place it in the Node Editor, unconnected, or, if you drag it over a connection line, inserted between two existing tools.
Jog and Shuttle

You can scrub clips in Icon view in the bin using one of two modes. Jog mode is the default mode. It moves the clip forward and backward as long as you are dragging the mouse. Once the mouse stops, the clip pauses.

You can choose Shuttle mode by right-clicking over the clip's thumbnail in the bin and choosing Scrub Mode > Shuttle.

Shuttle mode begins playing the clip forward or backward once you press the right mouse button and drag either left or right. The clip continues to play until the mouse button is released or you reach the end of the clip.

Stamp Files

Stamp files are low-resolution, local proxies of clips, which are used for playback of clips stored on a network server, or for very large clips.

**To create a stamp file for a clip:**

1. Right-click on the clip in the bin.
2. Choose Create Stamp from the contextual menu.

The Status bar at the top of the Bins window shows the progress of the stamp creation. Since the stamp creation is a background process, you can queue other stamps and can continue working with the composition.
Using the Studio Player

The Studio Player is a timeline-based playback interface built into the Bins window. It allows you to play and organize versions of compositions, make notes, and collaborate on shots and projects. The resolution-independent player uses any format that Fusion Studio can ingest, like EXR, ProRes, BMD RAW, QuickTime, and others. Clips use a RAM cache for playback, so even large formats can loop playback as long as there is available memory. Clips can contain audio and are output to a video monitor using Blackmagic Design Decklink or UltraStudio devices, allowing you to screen dailies and review shots. You can add annotation notes to the project, and setting up a Bin Server allows multiple artists to access the Studio Player.

Here are some Studio Player highlights:

– Clips can be played as single events, looped, or using a ping-pong playback, with a definable loop range.
– Clip metadata can be viewed, with live update during scrub/play.
– The Timeline interface can create a playlist for reviewing multiple clips.
– Per-shot color adjustment controls allow for consistent display of clips from different formats.
– Annotation notes can be typed on each clip and version, as well as the entire project.
– Audio Scratch track can be enabled for each clip during playback.
– Clip versions are stored in the same project to allow for quick access to previous work and for comparison of progress.
– Guide overlays can be customized to show monitor/title safety and show crops to various output formats.
– Blackmagic Design UltraStudio and DeckLink playback devices are supported for reviewing clips on video monitors and projectors.
– The fully collaborative workflow automatically synchronizes reel changes, annotations, and color adjustments across multiple workstations, allowing multiple artists or supervisors to access the same projects simultaneously.
– Remote sync allows multiple Studio Players to follow the master. Actions performed on the master, such as playback and scrubbing, will also be executed on the slaves, allowing the reel to be reviewed across multiple workstations or sites.
– Studios can automate tasks using the Fusion scripting engine to control the Studio Player.

Playing a Single Clip

Clips created from image sequences, MOV files, and some RAW formats can be previewed using the Studio Player without having to first add the clip to a node tree.

To play a clip in the Studio Player, do one of the following:

– Double-click a clip in a bin to open the Studio Player.
– Select the clip and click the Play button at the bottom of the bin window.
The Studio Player includes a large viewer, a Timeline, and a toolbar along the bottom.

Once you have the clip open in the Studio Player, you can click the Play button in the toolbar at the bottom of the window.

**Scrubbing the Timeline**
You can quickly preview the clip by scrubbing through it rather than playing it.

**To scrub a clip in Studio Player:**
1. In the Timeline, drag the playhead to the area you want to scrub over.
2. Use the Left and Right Arrow keys to move one frame forward or backward.

**Closing the Studio Player**
After you have finished previewing in the Studio Player, you can return to the Bins to switch to a new clip or continue working in Fusion.

**To close the current clip in the Studio Player and return to the bins:**
- Click the three-dot Options menu in the lower-left corner and choose Close.

**Creating a Reel**
A reel is a playlist or clip list that is viewed either as storyboard thumbnails or a timeline. In the bin, you create a new reel item to hold and play back multiple clips. The thumbnail for a reel appears with a multi-image border around it, making it easier to identify in the Bin window.
To create a reel in the current bin:
– Right-click in an empty area of the bin and choose New > Reel
– Click the Reel button along the bottom toolbar.

Use the New Reel button to create a reel in the current bin.

Once created and named, the reel appears in the current bin.

Double-clicking the reel opens the Studio Player interface along the bottom of the Bin window. An empty Studio Player appears in the top half of the window.

To add a clip to a reel:
1. Click the three-dot Options menu in the lower-left corner and choose Show Bins.
2. Drag a clip from one of the bins to the empty reel in the lower half of the window.

The toolbar across the bottom of the interface has various controls for setting a loop, showing and adjusting color, playback transport controls, collaboration sync, guide overlays, and frame number and playback speed in fps.

The toolbar along the bottom of the Studio Player includes controls to customize playback

**Toolbar buttons**

– **Set Loop In/Out**: Sets the start and end frame for playing a section of the Timeline in a loop.
– **Shot**: Sets the loop for the entire clip.
– **Reset**: Disables the loop mode.
– **M**: Shows Metadata of the image.
– **RGB and alpha**: Toggles between displaying the color and alpha of the clip.
– **Brightness Gamma**: Adjusts the brightness and gamma of the viewer and is applied to all clips. Individual clip color controls can also be applied using another menu.
– **Video**: Outputs the image to Blackmagic Design DeckLink and UltraStudio devices.
– **Transport controls**: Used to play forward, backward, fast forward, and fast backward, as well as go to the start and end of a clip.
– **Sync**: A three-way toggle allowing the Studio Player to be controlled or to control another player over a network. The Off setting disables this functionality.
– **Guide buttons**: These three buttons control the visibility of three customizable guide settings.
Inserting Shots
Clips or comps from the bin can be dragged to the storyboard area of the reel to add and organize a playlist.

To play the clips in a reel:
1. Click the three-dot Options menu in the lower-left corner and choose Show Player.
2. Position the playhead where you want to begin playing and click the Play button.

Creating Versions
Alternatively, you can add a version to an existing clip by dragging the new item on top.
Versions of a shot will appear as stacked icons in the storyboard reel. The number of stacks in the icon indicate the number of versions included with that clip. In the example below, the first shot has two versions, the second shot has four versions, and the last clip has only one version.

**Version Menu**

You can choose which version to view by right-clicking over the clip in the storyboard and selecting it from the Version > Select menu.

The Version menu also includes options to move or rearrange the order of the clip versions as well as remove a version, thereby deleting it from the stack.

**Shot Menu**

The per-clip Shot menu includes functions to Rename the shot, Remove the shot, Trim the clip’s In and Out points, add notes, adjust the color, and add an audio soundtrack.
– **Rename**: Allows you to change the name of the shot.
– **Remove**: Deletes the entire shot and all the versions from the project reel.
– **Trim**: Opens the Trim dialog to adjust the clip In point and Out point on the Timeline.
– **Notes**: Opens the Notes window to the right of the interface, allowing you to add a note to the specific shot.
– **Color**: Opens the Color Adjustments panel to perform Lift, Gamma, Gain, Brightness, and Contrast adjustments to clips.
– **Audio**: Allows you to attach an audio file to a clip in the Reel.

When notes are added, they are time and date stamped as well as name stamped. The naming is from the bin login name and computer name.

Selecting Color from the Shot menu allows you to make tonal adjustments per clip using Color Decision List (CDL) style controls.

The Audio menu option can import an audio .wav file that will play back along with the selected clip.

**Options Menu**

The three-dot Options menu in the lower left of the interface displays the menu that can be used to switch between viewer and the bin in the top half of the window. It is also used to clear the memory used in playback by selecting Purge Cache.
The Options menu includes options to switch the top half of the window between the viewer or bin contents.

Selecting Reel > Notes opens the Notes dialog to add annotations text to the entire reel project. The Reel > Export option saves the reel to disk as an ASCII readable format so it can be used elsewhere or archived.

The Reel submenu opens an area for production notes on the entire reel.

The View menu is used when you want to switch between the reel storyboard layout and a Timeline layout.

Guides
You can assign customizable guide overlays to three Guide buttons along the bottom of the Studio Player. Fusion includes four guides to choose from, but you can add your own using the XML Guide format and style information provided at the end of this chapter. You assign a customizable guide to one of the three Guide buttons by right-clicking over a button and selecting a guide from the list. To display the guide, click the assigned button.

Guides can be customized and placed in the the Guides folder:
- **On macOS**: Macintosh HD/Users/username/Library/Application Support/Blackmagic Design/Fusion/Guides/
- **On Windows**: C:\Users\username\AppData\Roaming\Blackmagic Design\Fusion\Guides.
- **On Linux**: home/username/.fusion/BlackmagicDesign/Fusion/Guides.
Guides are a simple XML formatted text document saved with the .guide extension, as defined below. This makes it easy to create and share guides.

**Custom Guide Format**

The guides are files that have drawing instructions a bit like code, like this:

```
Guide
{
    Name = "10 Pixels",
    Elements =
        {
            HLine { Y1="10T" },
            HLine { Y1="10B" },
            VLine { X1="10L" },
            VLine { X1="10R" },
        },
}
```

Or an example of safe area:

```
Guide
{
    Name = "Safe Frame",
    Elements =
        {
            HLine { Y1="10%", Pattern = 0xF0F0 },
            HLine { Y1="90%", Pattern = 0xF0F0 },
            HLine { Y1="95%" },
            HLine { Y1="5%" },
            VLine { X1="10%", Pattern = 0xF0F0 },
            VLine { X1="90%", Pattern = 0xF0F0 },
            VLine { X1="95%" },
            VLine { X1="5%" },
            HLine { Y1="50%", Pattern = 0xF0F0, Color = { R = 1.0, G = 0.75, B = 0.05, A=1.0 } },
            VLine { X1="50%", Pattern = 0xF0F0, Color = { R = 1.0, G = 0.75, B = 0.05, A=1.0 } },
        }
}
```
Guide Styles

The style of a guide is defined by a set of properties that appear in the format shown below:

```
<HLine Y1="33%" Pattern="C0C0" Color="FFFFFFFF"/>
```

- **HLine**: Draws a horizontal line and requires a Y-value, which is measured from the top of the screen. The Y-value can be given either in percent (%) or in absolute pixels (px).

- **Vline**: Draws a vertical line and requires an X-value, which is measured from the left of the screen. The X-value can be given either in percent (%) or in absolute pixels (px).

- **Pattern**: The Pattern value is made up of four hex values and determines the visual appearance of the line.

Examples for such patterns include:

```
>>FFFF draws a solid line ________________
>>EEEE a dashed line -------------------
>>ECEC dash-dot line -.-.-.-.-.-.-.-.-.
>>ECCC dash-dot-dot -..-..-..-..-..-..
>>AAAA dotted line ………………
```

- **Color**: The Color value is composed of four groups of two hex values each. The first three groups define the RGB colors; the last group defines the transparency. For instance, the hex value for pure red would be #FF000000, and pure lime green would be #00FF0000

- **Rectangle**: Draws a rectangle, which can be empty or filled, and supports the same pattern and color settings described above.

It requires two X- and two Y-values to define the extent <Rectangle Pattern="F0F0" X1="10%" Y1="10%" X2="90%" Y2="90%">

- **FillMode**: Applies to rectangles only and defines whether the inside or the outside of the rectangle should be filled with a color. Leave this value out to have just a bounding rectangle without any fill.

```
>>FillMode = ("None"|"Inside"|"Outside")
```

- **FillColor**: Applies to rectangles only and defines the color of the filled area specified by FillMode.

```
>>FillColor="FF000020"
```

Connecting Bins Over a Network

You can share bins among computers running Fusion on the network so that multiple visual effects artists can share assets, presets, and even entire compositions. These shared bins are called remote bins, and everyone can share one or more remote bin in a studio.

**To connect to a remote system and display its bins:**

1. Choose Fusion Studio > Preferences.
2. In the Preferences dialog, select Global > Bins > Servers in the list.
Adding a Remote Bin Entry

If you want to add another Remote bin to the list of available Remote bins, you can click the Add button in the bin servers Preferences panel. The text controls below the button will become enabled for editing. In the Server field, type the system name or IP address where the bin is hosted.

Add the IP address where the bin server is hosted.

Then add a User name and Password if one is needed to access the server.

The Library field lets you name the bins. So if you want to create a bin for individual projects, you would name it in the Library field, and each project would get its own bin.

The Application field allows larger studios to specify some other program to serve out the bin requests.
Once you've finished setting up the bin server information and clicked Save in the Preferences window, you can open the Bins window to test your bin server. Opening the Bins window is the first time your connection to the server will be tested. If it cannot connect, the bin server will still be listed, with access denied or unavailable marked next to the name on the bins sidebar.

There is no practical limit to the number of bins that can be accessed.

**Accessing Remote Bins**

Bin servers behave just like a local bins. Any bin added in the preferences show in the Bins sidebar as another top-level item. The available bins are shown by name with a status and, if required, a password. Bins unavailable to you are marked as (unavailable).

**Permissions**

Unlike other directories on a server, your access to bins on a network is stored in the bin document. The bins themselves contain all the users and passwords in plain text, making it easy for someone to administer the bins.

**Studio Player and Bin Server**

Reel projects can be shared by multiple artists across the studio via the bin server system, reviewing and adding versions and notes, all independently at the same time. With the Sync function, multiple people can collaborate together with synced playback and scrubbing.

The Sync button is a three-way toggle button: Off, Slave, and Master

When the Sync function is On, the transport controls can be set to control the playback or follow the master controller.

Master enables controlling other slave players on the network

The local transport controls can be disabled, causing playback to follow the master.
Chapter 75

Fusion Connect

This chapter goes into detail on how to use the Fusion Connect AVX2 plug-in with an Avid Media Composer editing system. The Fusion Connect AVX plug-in is only available with Fusion Studio.

Contents

Fusion Connect Overview 1306
System Requirements 1306
The Effects Palette 1306
The Layer Input Dialog 1307
Applying Fusion Connect to a Transition Point 1307
Export Clips 1307
Edit Effect 1308
Browse for Location 1308
Auto Render in Fusion 1309
Red on Missing Frames 1309
Compress Exported Frames 1309
Edit Effect Also Launches Fusion 1309
Versioning 1309
Create New Version 1309
Version 1309
About RAW Images 1309
About Color Depth 1310
Manual vs. Auto-Render 1310
Fusion/Avid Project Relationship 1312
Rendering with Fusion 1312
Directory Structure of Fusion Connect Media 1313
Advanced Project Paths 1314
Configuring Paths on macOS 1314
Configuring Paths on Windows 1315
Fields and Variables 1315
Environment Variables 1316
Fusion Connect Overview

Fusion Connect is an AVX2 plug-in for Avid Media Composer. It allows editors to create a conduit between the Timeline in Avid editing products and Fusion Studio. Fusion Connect exports clips from the Avid Timeline as image sequences and assembles Fusion compositions that allow you to work your magic on the content.

Fusion can be started automatically by the plug-in if Fusion is installed on the same system, or it can be used on remote computers to modify the composition.

System Requirements

Fusion Connect has the following requirements:

- **Supported Avid products**: Media Composer 8.x
- **Supported product**: Fusion Studio 8.1 or later
- **Installation**: Two files will be installed in your Media Composer:
  - Fusion Connect.avx
  - BlackmagicFusionConnect.lua
- **Avid's default directory**: \Avid\AVX2_Plug-ins

The Effects Palette

After launching Media Composer, Fusion Connect is located in the Blackmagic Effects Palette category. As with any segment or transition effect in the Effects Palette, you can apply the Fusion Connect AVX2 plug-in to any clip. This includes filler*, edit transition point, or video track layers on the Avid Timeline.

![Avid Media Composer Effects palette showing the Blackmagic category and Fusion Connect AVX plug-in.](image-url)
The Layer Input Dialog

When you apply the Fusion Connect AVX plug-in to a clip or a layer in the Timeline, you are presented with an AVX Optional Inputs dialog box.

Once the layer count is selected, Fusion Connect will be applied to the Timeline.

- Select the layer count equal to the number of video track layers you want to ingest into Fusion.
- Filler can be used as a layer.
- Fusion Connect will allow a maximum of eight layers.

Applying Fusion Connect to a Transition Point

If you apply Fusion Connect to a transition point, no dialog box will display, and the AVX plug-in will simply be applied to the Timeline transition point.

You can use the Avid dialog boxes or smart tools to adjust the length and offset of the transition to Start, Center, End, or Custom.

Export Clips

By pressing the Export Clips button in the Effects Editor, Fusion Connect exports all the associated clips as image sequences, to provide access to them in Fusion. Any previously exported existing images are overwritten, ensuring that all media needed by Fusion is accessible. Performing an export is desired if you want to use Fusion on a different computer than the one with Media Composer installed.

When using Fusion on the same computer as Media Composer, there is no need to export the clips explicitly by checking the Export Clips checkbox. Without this option enabled, Fusion Connect saves
the source frames each time images are displayed, scrubbed, or played back from the Timeline. Depending on your Media Composer Timeline settings, these interactively exported images might be half-resolution based on Avid proxy settings. When scrubbing around the Timeline, only a few frames—namely, those that are fully displayed during scrubbing—might be written to disk.

**TIP:** Set your Timeline Video Quality button to Full Quality (green) and 10-bit color bit depth. If the Timeline resolution is set to Draft Quality (green/yellow) or Best Performance (yellow), Fusion receives subsampled, lower-resolution images.

---

**Edit Effect**

After exporting the clips, the Edit Effect button performs three subsequent functions:

- Creates a Fusion composition, with Loaders, Savers, and Merges (for layers), or a Dissolve (for transitions). This function is only performed the first time a comp is created when the Fusion Connect AVX2 plug-in is applied.
- Launches Fusion (if installed on the machine), if it is not already launched.
- Opens the Fusion comp associated with created effects.

**Browse for Location**

The Fusion Connect media folders are created on the drive where the associated Avid media resides, defaulting to the root level of that drive. However, you can choose a new location for the Fusion Connect media.

**To choose another location to store and access the media:**

1. In the Media Composer Effects Editor, click the Browse for Location button.
2. In the File Browser, change the location and create additional folders if desired.

The path settings field in the Effects Editor updates to show the current location. If you apply Fusion Connect to another clip in the Timeline, the last location is remembered.
Auto Render in Fusion

The Auto Render button is a toggle that allows you to automatically render your Fusion comp from within Avid. Please note that this method of rendering has limitations and can be significantly slower than rendering directly in Fusion. It is mostly used for batch rendering on the Avid Timeline. Auto Render also exports the necessary media without having to manually execute the Export Clips function first.

Red on Missing Frames

The Red on Missing Frames button is a toggle used to display red images within the Avid Timeline viewer (Timeline monitor) if no rendered frames from Fusion Studio can be found, or if the rendered frames are not of a high enough resolution. When disabled, the original untouched frames will be shown instead of the red frame.

Compress Exported Frames

When enabled, this button creates Fusion RAW files with compression for, both exported and rendered frames. This creates smaller file sizes, saving disk space. As with any other compression algorithm, the compression adds time to the write process of the file sequence.

Edit Effect Also Launches Fusion

When enabled, this button opens Fusion Studio when the Edit Effect button is clicked, allowing for a more direct Avid/Fusion workflow. When disabled, this button will not launch Fusion Studio when the Edit Effect button is clicked, but a Fusion .comp file is created. This is useful when working with Fusion Studio on a separate computer than the one running the Media Composer software.

Versioning

Creating visual effects is almost always an iterative process. You'll often need to create revisions after your first pass at the effect. Built into Fusion Connect is a versioning feature that lets you create multiple revisions of an effect and switch between them from within Media Composer.

Create New Version

This checkbox creates a copy of the current comp without affecting the original. Any changes that are rendered in the copy will be written to a new folder and become another version of the rendered result played on the Avid Timeline. Previous versions of the comp and their rendered results are accessible using the Version slider.

Version

This slider selects which version of the comp is used in the Media Composer Timeline. It can be used to interactively switch from one version to the other in order to compare the results.

About RAW Images

Fusion Connect creates a Fusion RAW file image sequence for intermediate folders between Avid Media Composer and Fusion Studio, in order to preserve all the image information. This allows the images to reside on disk and not take up space in RAM. The benefits of using Fusion RAW include:

– The ability to continue the editing process while an effect is rendering
– The ability to take advantage of network rendering
– The ability to retime footage
– The ability to run Fusion Studio remotely
About Color Depth

Fusion Connect derives its images directly from the RGB data within Avid Media files. This allows the images to be codec agnostic. All RAW files from Avid that begin as 8- or 10-bit images are remapped to 16-bit float in Fusion. Rendered results from Fusion are processed in 16-bit float to maintain the full color fidelity supported by Media Composer.

Manual vs. Auto-Render

While Auto-Render is the easier workflow, the manual approach offers faster renderings in Fusion and more control over the performance and memory usage on your system.

- In the manual workflow, Fusion Studio is not required to be installed on the Avid system itself but can reside on any other computer.
- For Auto-Render, Fusion Studio must be installed on the local computer.

The following diagram shows typical workflows for manual and automatic renders.
Once the initial trip from Avid to Fusion is complete, depending on the type of clip to which you assigned the effect, in Fusion Studio you will be presented with one of the following:

- A Loader node representing a single clip.
- Two or more Loaders connected to Merge nodes representing layers.
- Two Loaders connected to a Dissolve node representing a transition.

In all three node tree layouts outlined above, there will also be a Saver node. The Saver node is automatically set to render to the directory that is connected back to the Media Composer Timeline with the correct format. If for some reason the file format or file path are changed in the Saver node, the Fusion Connect process will not render correctly.

**TIP:** Due to the design of the AVX2 standard, hidden embedded handles are not supported. To add handles, prior to exporting to Fusion, increase the length of your clip in the Media Composer Timeline to include the handle length.

---

Fusion results based on Avid timeline layouts

Fusion Node Editor representations of a single clip segment effect in the Media Composer Timeline (left), a multi-layered composite (center), and the transition (right)

**TIP:** If segments in the Avid Timeline have different durations, move the longest clip to the top layer and apply Fusion Connect to that clip. This will ensure all clips are brought into Fusion without being trimmed to the shortest clip.
Fusion/Avid Project Relationship

The frame rate and image size preferences created in Media Composer are adopted within Fusion’s frame rate preferences. This allows for consistency in formats for the roundtrip process from Avid to Fusion and back to Avid. The format settings do not prevent you from using or mixing any other sized imaging within the composition as Fusion is resolution independent.

Fusion Connect AVX uses frame rate and resolution from the Media Composer Timeline.

Rendering with Fusion

When you perform a render of your comp inside Fusion Studio, the results are rendered to the output folder created by Fusion Connect during the initial application of the plug-in to the Timeline. Upon rendering, you immediately see the results of the rendered Fusion comp in the Avid Timeline. Even while Fusion is rendering, you can continue with the edit process on any clip except for the associated clip being rendered at the time.
Directory Structure of Fusion Connect Media

Fusion Connect creates a logical folder structure that is not affiliated with the Avid Media Files folder but rather the Fusion Connect AVX2 plug-in. Based on data gathered during the AVX application to the Timeline, a logical folder hierarchy is automatically created based on Avid projects, sequences, and clips. This structure allows for multiple instances of Fusion Studio to access the media and multiple instances of the AVX to relate to a single Fusion comp. In a re-edit situation, media is never duplicated but is overwritten to avoid multiple copies of identical media.

If you apply the effect to a transition, the naming behavior might be somewhat different.
By default, Media Composer refers to the two clips of a transition as “Clip_001” and “Clip_002”. Based on the naming convention, Fusion Connect will create folders with matching names. If such folders already exist, because another transition has already used up “Clip_001” and “Clip_002”, the numbers will be incremented automatically.

Likewise, “_001” will be added incrementally to the group folder name, if a folder of that name already exists. The corresponding comp file will be named accordingly.

Fusion Connect AVX creates folder structures in the OS to save media and Fusion compositions. Those names are reflected in the Timeline.

You will notice that the Fusion Connect icon is a green dot (real-time) effect. If your hardware is fast enough, the results that populate the plug-in will play in real time. However, it’s recommended that you render the green dot effect, which will force an MXF precompute to be created to guarantee real-time playback.

**Advanced Project Paths**

The Fusion Connect AVX2 plug-in controls the pathing of Fusion Connect’s .raw media and Fusion’s .comp files as well as showing and hiding project and sequence level directories. This is achieved through environment variables, which are set in the operating system. This gives you the most flexible control over pathing your media, and as the name depicts, you can change variables (controls) in various application environments. This is useful for network storage and when Fusion Studio is running on other systems.

**Configuring Paths on macOS**

When using Fusion Connect on macOS, the Configure Path Defaults dialog looks like this:

Environment variable path maps on macOS.

Default paths can be configured using variables similarly as on Windows, but for added convenience it is possible to enter any desired path defaults directly into fields in the dialog, without the need for using environment variables.
Configuring Paths on Windows

When using Fusion Connect on Windows, the Configure Path Defaults dialog looks like this:

![Configure Path Defaults dialog](image)

Environment variable path maps on Windows.

Fusion Connect can define the user variables directly in the Fusion Connect plug-in. Click the Configure Path Defaults button to launch the path defaults dialog editor. In the Options section of the Fusion Connect AVX2 plug-in, click the triangle to reveal the path details.

Fields and Variables

Variables are the control title defined specifically by the application that is being controlled, while values are the instructions that tell a variable what to do. The fields and variables that can be used on macOS and Windows are described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Variable</th>
<th>Environment Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name</td>
<td>$PROJECT</td>
<td>CONNECT_PROJECT</td>
<td>Overrides the current Avid Project name.</td>
</tr>
<tr>
<td></td>
<td>$DRIVE</td>
<td>CONNECT_DRIVE</td>
<td>Drive or folder for all Connect projects</td>
</tr>
<tr>
<td></td>
<td>$SEQUENCE</td>
<td></td>
<td>Name of Avid sequence</td>
</tr>
<tr>
<td>Sequence Path</td>
<td>$SEQPATH</td>
<td>CONNECT_SEQUENCE_PATH</td>
<td>Folder for all Connect files in this sequence</td>
</tr>
<tr>
<td></td>
<td>$GROUP</td>
<td></td>
<td>Unique name of this Connect instance</td>
</tr>
<tr>
<td></td>
<td>$CLIP</td>
<td></td>
<td>Name of exported clip</td>
</tr>
<tr>
<td>Clip Path</td>
<td>–</td>
<td>CONNECT_CLIP_PATH</td>
<td>Folder for exported clips from Avid</td>
</tr>
<tr>
<td>Out Path</td>
<td>–</td>
<td>CONNECT_OUT_PATH</td>
<td>Folder for rendered results from Fusion</td>
</tr>
<tr>
<td>Comp Path</td>
<td>–</td>
<td>CONNECT_COMP_PATH</td>
<td>Location and name of Fusion comp file</td>
</tr>
</tbody>
</table>
**Environment Variables**

The pathing can be set in the environment variables of the system, so that IT management of the project paths can be achieved.

**Accessing the Environment Variables on Windows**

The quickest way to access environment variables is through your Windows control panel by searching the word “env” without the quotes. You have a choice of editing at a user level or system level.

**User Variables**

Click on the link that says “Edit environment variables for your account.”

**System Variables**

Click on the link that says “Edit the system environment variables.”

**Accessing the Environment Variables on macOS**

To set an environment variable on macOS, you must use the Terminal window. Environment variables on macOS are added to the .bash_profile directory for the current user.

**User Variables**

For system-wide operations, place the environment variable in “~/bash_profile

**TIP:** System variables control the environment throughout the operating system, no matter which user is logged in.

User variables always overrule any system variable; therefore, the user variable always wins if control for a specific function is duplicated in the user and system variable.

**System Variables**

For system-wide operations, place the environment variable in /etc/profile

**Environment Variables and What They Mean**

The Fusion Connect AVX plug-in can use environment variables to set different locations for certain folders or files. Each computer OS has a unique way of entering environment variables, but in every OS, the variable must be typed exactly as shown.

**TIP:** If you type directly in Fusion Connect’s Path Editor, you do not have to type the variable, just the value. You also can make modifications without having to restart the Media Composer! The only caveat is that in order to remove a variable, you must exit Media Composer and clear the environment variable in the Windows interface or macOS Terminal and restart the Media Composer.
Other values you can control derived from your Avid Bin include:

<table>
<thead>
<tr>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$DRIVE</td>
<td>This will force the directory to the drive where the Avid media is stored.</td>
</tr>
<tr>
<td>$PROJECT</td>
<td>This will force a directory based on the Avid project name for which the media was digitized/imported or AMA linked.</td>
</tr>
<tr>
<td>$SEQUENCE</td>
<td>This will force a directory based on the Avid SEQUENCE name for which the media was digitized/imported or AMA linked.</td>
</tr>
</tbody>
</table>

Here is an example of how a variable can be set up to support project and sequence names within your directory.

Environment variable project and sequence name examples on Windows

Here is the same example in the Windows environment variable editor.
Chapter 76

Preferences

This chapter covers the various options that are available from the Fusion Preferences Window.

Contents

Preferences Overview
Categories of Preferences
Preferences In Depth
AVI
Defaults
Flow
Frame Format
General
GPU
Layout
Loader
Memory
Network
Path Maps
Preview
QuickTime
Script
Spline Editor
Splines
Timeline
Tweaks
User Interface
Video Monitoring
View
VR Headsets
Preferences Overview

The Preferences window provides a wide variety of optional settings available for you to configure Fusion’s behavior to better suit your working environment. These settings are accessed via the Preferences window. The Preferences window can be opened from a menu at the top of the interface.

In DaVinci Resolve, to open the Fusion Preferences window, do one of the following:
- On macOS, switch to the Fusion page and choose Fusion > Fusion Settings.
- On Windows, switch to the Fusion page and choose Fusion > Fusion Settings.
- On Linux, switch to the Fusion page and choose Fusion > Fusion Settings.

In Fusion Studio, to open the Fusion Preferences window, do one of the following:
- On macOS, choose Fusion Studio > Preferences.
- On Windows, choose File > Preferences.
- On Linux, choose File > Preferences.
Global and Composition Preferences
The Preferences window is divided into a category sidebar on the left and the settings panel on the right. In Fusion Studio, there are two levels of preferences: Global and Composition. The Fusion page in DaVinci Resolve uses just a single Global preference that affects every project, new and existing.

The Global preferences are used to set options specific to Fusion’s overall behavior as well as defaults for each new composition. The Composition preferences in Fusion Studio can further modify the currently open composition without affecting the Global preferences or any other composition that is open but not displayed.

Categories of Preferences
The first entry in the Preferences sidebar is assigned to the Global preferences. Clicking the Global and Default Settings disclosure arrow reveals the following sections.

![Fusion Studio Global and Default settings](image)

3D View
The 3D View preferences offer control over various parameters of the 3D Viewers, including grids, default ambient light setup, and Stereoscopic views.

AVI (Windows Fusion Studio Only)
The AVI preferences configure the default compression options when creating AVI files from a Saver node. These settings can be overridden on a case-by-case basis using the Format tab in the Saver’s Inspector.

Defaults
The Defaults preferences are used to select default behavior for a variety of options, such as animation, global range, timecode display, and automatic tool merging.
Flow
You use the Flow preferences to set many of the same options found in the Node Editor’s contextual menu, like settings for Tile picture, the Navigator, and pipe style.

Frame Format
The Frame Format preferences are used to create new frame formats as well as select the default image height and width when adding new creator tools like Background and Text+. You also set the frame rate for playback.

General
The General preferences contain options for the general operation, such as auto save, and gamma settings for color controls.

GPU (Fusion Studio Only)
The GPU preferences include options for selecting specific GPU acceleration methods based on your computer platform and hardware capabilities. It is also used for enabling caching, and debugging GPU devices and tools.

Layout (Fusion Studio Only)
You can use the Layout preferences to save the exact layout of Fusion’s windows.

Loader (Fusion Studio Only)
Using the Loader preferences, you can set options for the default Loader’s depth and aspect ratio as well as define the local and network LoaderCache settings.

Memory (Fusion Studio Only)
Memory management for multi-frame and simultaneous branch rendering is configured in the Memory preferences.

Network (Fusion Studio Only)
The Network rendering preferences are used to configure options such as selecting a render master, email notification, and whether the machine can be used as a render slave.

Path Map
Path Map preferences are used to configure virtual file path names used by Loaders and Savers as well as the folders used by Fusion to locate comps, macros, scripts, tool settings, disk caches, and more.

Preview (Fusion Studio Only)
The Preview preferences is where you configure the Preview creation and playback options.

QuickTime (macOS Fusion Studio Only)
This section lets you preconfigure the QuickTime codec used for rendering.

Script
The Script preferences include a field for passwords used to execute scripts externally, programs to use for editing scripts, and the default Python version to use.
Spline Editor
The Spline Editor preferences allow you to set various spline options for Autosnap behavior, handles, markers, and more.

Splines
Options for the handling and smoothing of animation splines, Tracker path defaults, onion-skinning, roto assist, and more are found in the Splines preference.

Timeline
The Timeline preferences is where you create and edit Timeline/Spline filters and set default options for the Keyframes Editor.

Tweaks
The Tweaks preferences handle miscellaneous settings for modifying the behavior when loading frames over the network and queue/network rendering.

User Interface
These preferences set the appearance of the user interface window and how the Inspector is displayed.

Video Monitoring (Fusion Studio Only)
The Video Monitoring preferences is where you can configure your Blackmagic video display hardware for monitoring on an HD, Ultra HD, or DCI 4K display.

View
The View preferences are used to manage settings for viewers, including default control colors, Z-depth channel viewing ranges, default LUTs, padding for fit, zoom, and more.

VR Headsets
The VR Headsets preferences allow configuration of any connected Virtual Reality headsets, including how stereo and 3D scenes are viewed.

Bins (Fusion Studio Only)
There are three panels as part of the Bins preferences: a Security panel where you set users and passwords for serving the local bins; a Servers panel used to select which remote Bin servers are connected; and a Settings panel for stamp rendering.

Import
The Import settings contain options for EDL Import that affect how flows are built using the data from an EDL.
Preferences In Depth

Within each category is a deep set of controls for configuring Fusion so that it better fits your working environment. The preferences contain both software and hardware options that affect all newly created comps. The following section explains every option located in the preferences categories.

3D View

The 3D View preferences contain settings for various defaults in the 3D Viewers, including grids, default ambient light setup, and Stereoscopic views.

Grid

The Grid section of the 3D View preferences configures how the grid in 3D Viewers are drawn.

- **Grid Antialiasing**: Some graphics hardware and drivers do not support antialiased grid lines, causing them to sort incorrectly in the 3D Viewer. Disabling this checkbox will disable antialiasing of the grid lines. To turn off the grid completely, right-click in a 3D Viewer and choose 3D Options > Grid.

- **Size**: Increasing the Size value will increase the number of grid lines drawn. The units used for the spacing between grid lines are not defined in Fusion. A "unit" is whatever you want it to be.

- **Scale**: Adjusting the overall scaling factor for the grid is useful, for example, if the area of the grid appears too small compared to the size of your geometry.
Perspective Views
The Perspective Views section handles the appearance of the perspective view in both a normal and stereoscopic project.

- **Near Plane/Far Plane**: These values set the nearest and furthest point any object can get to or from the camera before it is clipped. The minimum setting is 0.05. Setting Near Plane too low and Far Plane too far results in loss of depth precision in the viewer.
- **Eye Separation/Convergence/Stereo Mode**: This group of settings defines the defaults when stereo is turned on in the 3D Viewer.

Orthographic Views
Similar to the Perspective Views, the Orthographic Views (front, top, right, and left views) section sets the nearest and furthest point any object can get to or from the viewer before clipping occurs.

Fit to View
The Fit to View section has two value fields that manage how much empty space is left around objects in the viewer when the F key is pressed.

- **Fit Selection**: Fit Selection determines the empty space when one or more objects are selected and the F key is pressed.
- **Fit All**: Fit All determines the empty space when you press F with no objects selected.

Default Lights
These three settings control the default light setup in the 3D Viewer.

The default ambient light is used when lighting is turned on and you have not added a light to the scene. The directional light moves with the camera, so if the directional light is set to “upper left,” the light appears to come from the upper-left side of the image/camera.

AVI
The AVI preference is only available in Fusion Studio on Windows. It configures the default AVI codec settings when you select AVI as the rendering file format in the Saver node.

- **Compressor**: This drop-down menu displays the AVI codecs available from your computer. Fusion tests each codec when the application opens; therefore, some codecs may not be available if the tests indicate that they are unsuitable for use within Fusion.
- **Quality**: This slider determines the amount of compression to be used by the codec. Higher values produce clearer images but larger files. Not all codecs support the Quality setting.
- **Key Frame Every X Frames**: When checked, the codec creates keyframes at specified intervals. Keyframes are not compressed in conjunction with previous frames and are, therefore, quicker to seek within the resulting movie. Not all codecs support the keyframe setting.
- **Limit Data Rate To X KB/Second**: When checked, the data rates of the rendered file are limited to the amount specified. Not all codecs support this option. Enter the data rate used to limit the AVI in kilobytes (kB) per second, if applicable. This control does not affect the file unless the Limit Data Rate To option is selected.

Defaults
The choices made here are used to determine Fusion’s behavior when new tools are added to the Node Editor and when parameters are animated.
The Defaults preferences

Default Animate
The Default Animate section is used to change the type of modifier attached to a parameter when the Animate option is selected from its contextual menu. The default option is Nothing, which uses a Bézier spline to animate numeric parameters and a path modifier for positional controls.

- **Number With and Point With**: Drop-down lists are used to select a different modifier for the new default. For example, change the default type used to animate position by setting the Point with the drop-down menu to XY Path.

  Choices shown in this menu come from installed modifiers that are valid for that type of parameter. These include third-party plug-in modifiers, as well as native modifiers installed with Fusion.

Auto Tools
The Auto Tools section determines which tools are added automatically for the most common operations of the Background tools and Merge operations.

- **Background**: When set to None, a standard Background tool is used; however, the drop-down menu allows you to choose from a variety of tools including 2D and 3D tools to customize the operation to your workflow.

- **Merge**: When set to None, nothing happens. When set to Merge, connecting the outputs of two tools or dragging multiple clips on the Node Editor uses a standard Merge. Other valid options for this are Anaglyph, Channel Booleans, and Dissolve.

- **Use Merge Only When Connecting Outputs Directly**: When this option is active, Merges are not automatically added when you drag multiple clips from the Finder or Windows Explorer onto the Flow area.

Global Range
Using the Start and End fields, you can define the Global Start and End frames used when creating new compositions.
Time Code
You use this option to determine whether new compositions will default to showing SMPTE Time Code or frames (Feet + Frames) to represent time.

Flow
Many of the same options found in the Node Editor’s contextual menu, like settings for Tile Picture, the Navigator, and Pipe Style, are found in this category.

The Flow preferences

Force
The Force section can set the default to display pictures in certain tool tiles in the Node Editor rather than showing plane tiles. The Active checkbox sets pictures for the actively selected tool, the All checkbox enables pictures for all tiles, and the Source and Mask checkbox enables tile pictures for just Source and Mask tools.

When All is enabled, the picture shown will either be a thumbnail of the image rendered by the tool if the tool has rendered, or if the Show Thumbnails option is disabled, the tool’s default icon is used. Concatenated transforms will also show a default icon.

– **Show Modes/Options**: Enabling this option will display icons in the tool tile depicting various states, like Disk Caching or Locked.

– **Show Thumbnails**: When this checkbox is selected, tool tiles set to show tile pictures will display the rendered output of the tool. When the checkbox is cleared, the default icon for the tool is used instead.
Options
The Options section includes several settings that control or aid in the layout and alignment of tools in the Node Editor.

– **Arrange to Grid**: This enables a new node tree’s Snap to Grid option to force the tool layout to align with the grid marks in the flow.

– **Arrange to Connected**: Tools snap to the vertical or horizontal positions of other tools they are connected to.

– **Auto Arrange**: This option enables the Node Editor to shift the position of tools as needed to make space when inserting new tools or auto-merging layers.

– **Show Grid**: This enables or disables the display of the Node Editor’s background grid.

– **Auto Remove Routers**: Pipe Routers or “elbow nodes” in the Node Editor are considered “orphaned” if the tools connected to either the input or output are deleted. When this option is enabled, Orphaned Routers are automatically deleted.

– **Pipes Always Visible**: When enabled, the connection lines between tools are drawn over the top of the tool tiles.

– **Keep Tile Picture Aspect**: Enabling this option forces tool tile thumbnail pictures to preserve the aspect of the original image in the thumbnail.

– **Full Tile Render Indicators**: Enabling this checkbox causes the entire tile to change color when it is processing. This can make it easier to identify which tools are processing in a large composition. The coloring itself will form a progress bar to alert you to how close slower tools are to finishing their process.

– **Show Instance Links**: This option is used to select whether Instance tools will show links, displayed as green lines, between Instance tools.

– **Navigator**: The Navigator is a small square overview of the entire composition. It is used to quickly navigate to different parts of a node tree while you are zoomed in. The checkboxes in this section determine when the Navigator is displayed, if at all.

  – **On**: The Navigator will always be visible.

  – **Off**: The Navigator will always be hidden.

  – **Auto**: The Navigator will only be visible when the Node Editor’s contents exceed the currently visible Work area.

– **Pipe Style**: This drop-down menu selects which method is used to draw connections between tools. The Direct method uses a straight line between tools, and Orthogonal uses horizontal and vertical lines.

– **Build Direction**: When auto-building or laying out a node tree, Build Direction controls whether tools are organized horizontally or vertically.

– **Scale**: The Scale menu allows you to select the default zoom level of the Node Editor when a new composition is created.

Pipe Grab Distance
The Pipe Grab Distance slider allows you to choose how close the pointer must be (in pixels) to a connection line in the node tree when selecting them.

Link Grab Distance
The Link Grab Distance slider allows you to choose how close the pointer must be (in pixels) to a knot on a node before a connection is made or removed. 0 pixels means you must be directly on the knot, while a maximum setting of 20 means you can be 20 pixels from a knot and still connect to it.
Group Opacity
This slider controls the opacity of an expanded group’s background in the Node Editor.

Frame Format
Frame Format preferences allow you to select the resolution and frame rate for the nodes that generate images like Background, fast noise, and Text+. It also sets the color bit depth for final renders, previews, and interactive updates in the viewer. The color bit depth settings only apply to Fusion Studio. Rendering in DaVinci Resolve always use 32-bit float.

Default Format
This drop-down menu is used to select the default resolution for Generator tools from a list of presets. This is only a default setting; these settings can be overridden using the Resolution settings in a node’s Inspector.

Use the Edit boxes to change any of the default settings. When creating a new setting, press the New button and enter a name for the setting in the dialog box that appears and enter the parameters.
Settings
The Settings section defines the format that is selected in the Default Format menu. You can modify an existing format or create a new one.

– **Width/Height:** When creating a new format for the menu or modifying an existing menu item, you specify the Width or Height in pixels of the format using these fields.

– **Frame Rate:** Enter or view the frames per second played by the format. This sets the default Frame Rate for previews and final renders from the Saver tool. It also sets the playback for the comp itself, as well as the frame to time code conversion for tools with temporal inputs.

– **Has Fields:** When this checkbox is enabled, any Creator or Loader tool added to the Node Editor will be in Fields process mode.

– **Film Size:** This field is used to define how many frames are found in one foot of film. The value is used to calculate the display of time code in Feet + Frames mode.

– **Aspect Ratio:** These two fields set the pixel aspect ratio of the chosen frame format.

– **Guide 1:** The four fields for Guide 1 define the left, top, right, and bottom guide positions for the custom guides in the viewer. To change the position of a guide, enter a value from 0 to 1. The bottom-left corner is always 0/0, the top-right corner is always 1/1. If the entered value’s aspect does not conform to the frame format as defined by the Width and Height parameters, an additional guide is displayed onscreen. The dotted line represents the image aspect centered about Guide 1’s Center values.

– **Guide 2:** This setting determines the image aspect ratio in respect to the entire frame format width and height. Values higher than 1 cause the height to decrease relative to the width. Values smaller than 1 cause height to increase relative to width.

– **New:** You use the New button to create a new default setting in the drop-down menu. Once you click the button, you can name the setting in the dialog box that appears.

– **Copy:** The Copy button copies the current setting to create a new one for customization.

– **Delete:** The Delete button will remove the current setting from the default drop-down list.

Color Depth
The three menus in the Color Depth section are used to select the color mode for processing preview renders, interactive renders, and full (final) renders. Processing images at 8-bit is the lowest color depth and is rarely sufficient for final work these days but is acceptable for fast previews. 16-bit color has much higher color fidelity but uses more system resources. 16-bit and 32-bit float per channel uses even more system resources and is best for digital film and HDR rendered images.

Generally, these options are ignored by the composition unless a Loader or Creator tool’s Color Depth control is set to Default.

General
The sections contained in the General preferences affect the behavior of the Inspector as well as some other user interface elements.
Usability

Usability has a number of project, Node Editor, and user interface settings that can make the application easier to work with, depending on your workflow.

- **Auto Clip Browse**: When this checkbox is enabled, the File Browser is automatically displayed when a new Loader or Saver is added to the Node Editor.

- **New Comp on Startup**: When checked, a new, empty project is created each time Fusion Studio is launched. This has no effect in DaVinci Resolve’s Fusion page.

- **Summarize Load Errors**: When loading node trees or “comps” that contain unknown tools (e.g., comps that have been created on other computers with plug-ins not installed on the current machine), the missing tools are summarized in the console rather than a dialog being presented for every missing tool.

- **Save Compressed Comps**: This option enables the saving of compressed node trees, rather than ASCII based text files. Compressed node trees take up less space on disk, although they may take a moment longer to load. Node trees containing complex spline animation and many paint strokes can grow into tens of megabytes when this option is disabled. However, compressed comps cannot be edited with a text editor unless saved again as uncompressed.

- **Show Video I/O Splash**: This toggles whether the Splash image will be displayed over the video display hardware. This is only applies to Fusion Studio.

- **Use Simplified Copy Names**: This option reduces the occurrence of underscores in tool names when copying.

- **Show Render Settings**: When this checkbox is selected, the Fusion Render Settings dialog will be displayed every time a render is started in Fusion Studio. Holding Shift while starting a render will prevent the display of the dialog for that session, using whatever settings were applied during the last render. Disabling this option reverses this behavior.
– **Mouse Wheel Affects the Window Under the Pointer:** Normally the mouse wheel or trackpad swiping works in the currently active window. With this option enabled, it will work in the window underneath the cursor, so you don’t have to click into a window first to make it active.

– **Frames Start From:** This designates the starting frame number for clip times in the Loader and its Clip list.

– **Show Color As:** This setting determines the numeric scale used to represent colors. The available options are Normalized (0 to 1), 8-bit (0 to 255), and 16-bit (0 to 65,535). This does not affect the actual processing or quality of the image, but it can make the mental math sometimes used to figure out adjustments a bit easier.

**Auto Save**

The Auto Save settings only apply to Fusion Studio. To set auto backups for the Fusion page in DaVinci Resolve, use the DaVinci Resolve Project Load and Save Preferences.

When Auto Save is enabled in Fusion Studio, comps are automatically saved to a backup file at regular intervals defined by the Delay setting. If a backup file is found when attempting to open the comp, you are presented with the choice of loading either the backup or the original.

If the backup comp is opened from the location set in the Path Map preference, saving the backup will overwrite the original file. If the backup file is closed without saving, it is deleted without affecting the original file.

– **Save Before Render:** When enabled, the comp is automatically saved before a preview or final render is started.

– **Delay:** This preference is used to set the interval between Auto Saves. The interval is set using mm:ss notation, so entering 10 causes an Auto Save to occur every 10 seconds, whereas entering 10:00 causes an Auto Save every 10 minutes.

**Proxy**

– **Update All, Selective, No Update:** The Update mode button is located above the toolbar. You can use this preference to determine the default mode for all new comps. Selective is the usual default. It renders only the tools needed to display the images in the Display view. All will render all tools in the composition, whereas None prevents all rendering.

– **Standard and Auto:** These sliders designate the default ratio used to create proxies when the Proxy and Auto Proxy modes are turned on. These settings do not affect the final render quality.

Even though the images are being processed smaller than their original size, the image viewing scales in the viewers still refer to original resolutions. Additionally, image processing performed in Proxy Scale mode may differ slightly from full-resolution rendering.

The Proxy and Auto Proxy size ratios may be changed from within the interface itself by right-clicking on the Prx and APrx buttons above the toolbar and selecting the desired value from the contextual menu.

**GPU**

The GPU preference is only available in Fusion Studio. In DaVinci Resolve, you can configure the GPU processing in Resolve’s Memory and GPU preferences.

In Fusion Studio, the GPU preference is used to specify the GPU acceleration method used for processing, based on your computer platform and hardware capabilities. It is also used for enabling caching and debugging GPU devices and tools.
Options
The GPU options include radio buttons to select whether the GPU is used when processing and, if so, which computer framework is used for communicating with the GPU.

- **GPU Tools:** This preference has three settings: Auto, Disable, and Enable. When set to Disable, no GPU acceleration is used for tools or third-party plug-ins. Fuses may still require GPU acceleration. If Enable is selected, GPU acceleration is available for tools and plug-ins, if appropriate drivers are installed.

- **API:** The API setting selects the GPU processing method to use.

- **Device:** The Device setting determines which GPU hardware to use in the case of multiple GPUs. The Auto setting gives priority to GPU processing; however, if it is unavailable, Fusion uses the platform default. Currently, both the AMD and CPU options require either the AMD Catalyst 10.10 Accelerated Parallel Processing (APP) technology Edition driver or the ATI Stream SDK 2.1 or later to be installed. The Select setting allows you to choose the device explicitly.

Debugging
The more advanced preferences located in this section are designed for diagnostics and analyzing GPU operations.

- **Verbose Console Messages:** Enabling this option causes information to be shown in the Console. For example, Startup Logs, Compiler Warnings, and Messages.

- **OpenGL Sharing:** Enabling this option shares system RAM with onboard GPU RAM to create a larger, but slower, OpenGL memory pool.

- **Clear Cache Files:** This option will clear already compiled GPU code and then recompile the kernels.
Layout

The Layout preferences are only available in Fusion Studio. To save a Layout in DaVinci Resolve’s Fusion page, use the Workspace > Layout Presets menu. The Layout options are used to control the layout, size, and position of various windows in Fusion’s interface at startup or when a comp is created.

There are a lot of options, but in practice, you simply organize the interface the way you prefer it on startup and when a new composition is created, then open this Preferences panel and click on the three buttons to grab the Program Layout, the Document Layout and the Window Settings.

Program Layout

The Program Layout is used to save the overall Fusion interface window and any open floating windows. Each new composition you open within the lager overall Fusion interface window will adhere to these preferences.

- **Grab Program Layout**: Pressing this button stores the application’s overall current position and size.
- **Run Mode**: This menu is used to select the application’s default mode at startup. You choose between a Maximized application window, a Minimized application, or a Normal application display.
- **Use the Following Position and Size**: When checked, the values stored when Grab Program Layout was selected will be used when starting Fusion Studio.
- **Create Floating Views**: When checked, the position and size of the floating viewers will be saved when the Grab Program Layout button is used.
Document Layout

The Document Layout is used to save the layout of panels and windows for the current Fusion comp.

- **Recall Layout Saved In Composition**: When checked, all Document Layout settings in the controls below will be recalled when a saved composition is loaded.

- **Grab Document Layout**: Pressing this button stores the entire interface setup, including all the internal positions and sizes of panels and work areas.

- **Window**: When multiple windows on the same composition are used, this menu is used to select the window to which the Window Settings will apply.

Window Settings

Rather than saving entire comp layouts, you can save position and size for individual floating windows and panels within a comp using the Window Settings.

- **Automatically Open This Window**: When checked, the selected window will automatically be opened for new flows.

- **Grab Window Layout**: Pressing this button stores the size and position of the selected window.

- **Run Mode**: Select the default run mode for the selected window. You can choose between a Maximized window, a Minimized window, or a Normal window display.

- **Use Grabbed Position and Size**: When checked, the selected window will be created using the stored position and size.

Loader

The Loader preferences are only available in Fusion Studio. Using the Loader preferences, you can set options for the default Loader’s color depth and aspect ratio as well as define the local and network cache settings.
Defaults
The Defaults section includes two settings to determine how color depth and aspect ratio are handled for Loaders.

– **Loader Depth**: The Loader Depth defines how color bit depth is handled when adding a Loader. Choosing Format means that the correct bit depth is automatically selected, depending on the file format and the information in the file’s header. Choosing Default sets the bit depth to the value specified in the Frame Format preferences.

Cache
The Cache preferences allow you to control how disk caching operates in Fusion. You can set how and where the cache is generated, when the cache is removed, how the cache reacts when source files are not available, as well as many other cache related options. This is not to be confused with RAM cache, which is controlled in the Memory preferences.

– **Disable All Local Caching**: This setting disables local caching.

– **Cache Files from Network Disk Caches**: If a tool has disk caching enabled, and the disk cache files are stored remotely on the network, then enabling this option will use a local copy of those cache files, similarly to the local cache on a networked Loader.

– **Enable Local Caching of Loaders**: Files will be copied into the LoaderCache path set below or in the Path Maps preferences.

– **Cache Multi-Frame Files**: Files like AVI or QuickTime will be copied into the LoaderCache path. This may take some time if the file is large.

– **Don’t Cache Files from Local Disks**: Files that do not sit on a network drive will not be copied into the LoaderCache path. You can disable this option if you have, for example, a fast SSD cache drive and want to use it for local files as well to speed up file access while working interactively.

– **Only Files Smaller Than xxx MB.**: Files larger than the value set here will not be copied into the LoaderCache path.

– **Cache Path Separator Character**: When Enable Local Caching of Loaders is enabled, you can use this setting to rebuild the path of the original files in LoaderCache.

  For instance, given the default “!” character, the original path X:\Project\MyShots\Shot0815\ will be translated into X!Project!MyShots!Shot0815! in the LoaderCache path. Other separator characters may be used, including the “\” character, which will use subdirectories in LoaderCache: X\Project\MyShots\Shot0815\.

– **If Original File Is Missing**: This setting provides three options to determine the caching behavior when the original files can’t be found. The Fail option behaves exactly as the Default Loader in Fusion. The Loader will not process, which may cause the render to halt. The Load Cache option loads the cache even though no original file is present. The Delete Cache option clears missing files from the cache.

– **Cache Location**: For convenience, this is a copy of the LoaderCache path set in the Path Maps preferences.

– **Explore**: This button opens the LoaderCache path in the macOS X Finder window or a Windows Explorer window.

– **Clear All Cache Files**: This button deletes all cached files present in the LoaderCache path.
Memory

The Memory preferences are only available in Fusion Studio. To control Fusion’s memory when using the Fusion page in DaVinci Resolve, open DaVinci Resolve’s Memory and GPU preferences.

Occasionally, it will be necessary to adjust the Memory preferences in order to make the best use of available memory on the computer. For example, some people prefer a higher cache memory for faster interactive work, but for final renders the cache memory is often reduced, so there’s more memory available for simultaneous processing of tools or multiple frames being rendered at once.

Caching Limits

The Caching Limits include options for Fusion’s RAM cache operation. Here, you can determine how much RAM is allocated to the RAM cache for playing back comps in the viewer.

- **Limit Caching To:** This slider is used to set the percentage of available memory used for the interactive tool cache. Available memory refers to the amount of memory installed in the computer.
  
  When the interactive cache reaches the limit defined in this setting, it starts to remove lower priority frames in the cache to clear space for new frames.

- **Automatically Adjust In Low Memory Situations:** This checkbox will set the caching to adjust when memory is low. The console will display any cache purges.

- **Leave At Least X MBytes:** This setting is used to set the hard limit for memory usage. No matter what the setting of the Cache Limit, this setting determines the amount of physical memory available for use by other applications. Normally, this value should not be smaller than 25 MBytes.
Interactive Render
The Interactive Render option allows you to optimize Fusion’s processing based on the amount of RAM you have installed in your system.

– **Simultaneous Branching**: When checked, more than one tool will be processed at the same time. Disable this checkbox if you are running out of memory frequently.

Final Render
These settings apply to memory usage during a rendering session, either preview or final, with no effect during an interactive session.

– **Render Slider**: This slider adjusts the number of frames that are rendered at the same time.
– **Simultaneous Branching**: When checked, more than one branch of a node tree will be rendered at the same time. If you are running low on memory, turn this off to increase rendering performance.

Network
The Network preferences are only available in Fusion Studio. These preferences are used to set up and control network rendering in Fusion Studio. The majority of settings are found in the Render Manager dialog.

![The Network preferences](image)
Submit Network Render Compositions
In these fields, you enter the Master Name and IP address of the computer that will manage all network renders sent from this machine. If a standalone render master is in use on the network, these fields may be pre-filled and may not be editable. This is done to prevent multiple unauthorized render masters from being created by each person in a facility.

To re-enable editing of the master name and IP, create the environment variable FUSION_NO_MANAGER and set the value to True. Check your operating system user guide for how to create environment variables.

General
The General preferences are designed with the most used options at the top in the General section. These options determine in what capacity the system is used during network rendering.

– **Make This Machine a Render Master:** When enabled, Fusion will accept network render compositions from other computers and manage the render. It does not necessarily mean that this computer will be directly involved in the render, but it will submit the job to the render nodes listed in the Render Manager dialog.

– **Allows This Machine to Be Used as a Network Slave:** When enabled, this computer can be used as a Render node and will accept compositions for network rendering. Deselect it to prevent other people from submitting compositions to render on this computer.

– **Render on All Available Machines:** Enable this checkbox to ignore groups and priorities configured in the Render Manager. Compositions submitted from this computer for network rendering will always be assigned to every available slave.

Email Notification
You can use the Email Notification section to set up who gets notified with status updates regarding the render jobs and the network.

– **Notify Options:** These checkboxes cause emails to be sent when certain render events take place. The available events are Queue Completion, Job Done, and Job Failure.

– **Send Email to:** Enter the address or addresses to which notifications should be sent. You separate multiple addresses with a semicolon.

– **Override Sender Address:** Enter an email address that will be used as the sender address. If this option is not selected, no sender address is used, which may cause some spam filters to prevent the message from being delivered to the recipient.

Server Settings
This section covers Clustering and Network Rendering. For more information on these settings and clustering, see Chapter 65, “Rendering Using Saver Nodes” in the DaVinci Resolve Reference Manual or Chapter 4 in the Fusion Reference Manual.
Path Maps

Path Maps are virtual paths used to replace segments of file paths with variables. For example, define the path ‘movie_x’ as actually being X:\Shows\Movie_X. Using this example, Fusion would understand the path ‘movie_x\scene_5\scan.000.cin’ as actually being X:\Shows\Movie_X\scene_5\scan.000.cin.

The Path Map preferences

For Fusion Studio, there are two main advantages to virtual path maps instead of actual file paths. One is that you can easily change the path to media connected to Loaders (for example, when moving a comp from one drive to another), without needing to make any changes in the composition. The other advantage is when network rendering, you can bypass the different OS filename conventions.

– **Enable Reverse Mapping of Paths Preferences:** This checkbox is at the top of the Path Map settings. When enabled, Fusion uses the built-in path maps for entries in the path’s settings when applying mapping to existing filenames. The main benefit is for Fusion Studio. Enabling this checkbox causes Loaders to automatically use paths relative to the location of the saved composition when they are added to the Node Editor. For more information on using relative paths for Loaders, see Chapter 105, “IO Nodes,” in the DaVinci Resolve Reference Manual or Chapter 44 in the Fusion Reference Manual.

As with other preferences in Fusion Studio, paths maps are available in both Global and Composition preferences. Global preferences are applied to all new compositions, while Composition path maps are only saved with the current composition. Composition path maps will override Global path maps with the same name.
The Global paths maps are divided into three sections:

- **System Path Maps**: The operating system determines system path maps, and they define Fusion’s global locations. You can override specific System path maps using the Defaults or current Composition Path Map settings. If you change your mind at a later time, you are always able to return to Fusion’s “factory” defaults using the System path maps. There are several top-level path maps established in the System Path Map settings.

- **AllData**: The folder where Fusion saves all shared application data.

- **AllDocs**: The folder where Fusion saves the public/shared document folder.

- **AllLUTs**: The nested LUTs path in the Defaults section, where Fusion saves LUTs.

- **Fusion**: The folder where Fusion Studio app is installed. For example, if you open Fusion from C:\Program Files\Fusion, then the path Fusion:\Help refers to C:\Program Files\Fusion\Help. If you instead used a copy of Fusion found in \post-server\fusion\16, then Fusion:\Help would expand to \post-server\fusion\16\Help.

- **FusionLibs**: The Fusion libraries used for the application.

- **Profile**: The folder where default Fusion preferences file is saved.

- **Profiles**: The folder where Fusion individual user preferences are saved.

- **Programs**: The location of Fusion Studio or DaVinci Resolve.

- **SystemFonts**: The folder where the OS saves fonts that appear for Text+ and Text 3D nodes.

- **Temp**: The system’s temporary folder.

- **UserData**: The folder where Fusion saves all user-specific miscellaneous roaming data. The individual elements included in the roaming data are listed in the Default Path Maps section. For Fusion Studio on Windows, this is “C:\Users\username\AppData\Roaming\”. On Linux, this will be “$HOME/Blackmagic/Fusion”. On macOS, this is “Users/UserName/Library/Application Support/Blackmagic Design/Fusion”.

- **UserDocs**: The folder where Fusion saves the user’s document folders.

- **Default Path Maps**: The Defaults are user-editable path maps. They can reference the System paths, as part of their paths. For instance, the Temp folder is defined in the System path and used by the Default DiskCache path map to refine the nested location (Temp:DiskCache). Default path maps can also redirect paths without using the Global System path maps. After you change a Default, the updated setting can be selected in the Preferences window, and a Reset button at the bottom of the Preferences window will return the modified setting to the System default.

- **AutoSaves**: This setting determines the Fusion Comp AutoSave document’s location, set in the Fusion General preferences.

- **Bins**: Sets the location of Fusion Studio bins. Since the bins use pointers to the content, the content is not saved with the bin. Only the metadata and pointers are saved in the bins.

- **Brushes**: Points Fusion to the folder that contains custom paintbrushes.

- **Comps**: The folder where Fusion Studio compositions are saved. On macOS or Windows, the default location is in Users/YourUserName/Documents/Blackmagic Design/Fusion.

- **Config**: Stores Configuration files used by Fusion Studio during its operation.

- **Defaults**: Identifies the location of node default settings so they can be restored if overwritten.

- **DiskCache**: Sets the location for files written to disk when using the Cache to Disk feature. This location can be overridden in the Cache to Disk window.

- **Edit templates**: The location where Fusion macros are saved in order to appear as templates in the DaVinci Resolve Effects Library.

- **Filters**: Points to a folder containing Convolution filters like sharpen, which can be used for the Custom Filter node.
– **Fonts**: The default path map for Fonts points to the operating system fonts folders. Changing this will change the fonts that are available in the Text+ or Text 3D nodes as well as any Fusion Title Template. In DaVinci Resolve. This path map does not affect the five additional Edit page titles (L Lower 3rd, R Lower 3rd, M Lower 3rd, Scroll, and Text.)

– **Fuses**: Points to a folder containing Fusion Fuses plug-ins.

– **FusionTemplates**: Location where Fusion macros are saved in order to appear as templates in Fusion’s Effects Library.

– **Guides**: Location where custom viewer guide overlays are stored.

– **Help**: Identifies where Fusion Studio PDF files are located.

– **Layouts**: Location where Fusion Studio custom window layouts are saved.

– **Libraries**: Points to a support folder where custom Effects Library items can be stored.

– **LoaderCache**: The Fusion Studio Loader preferences allow the Loader to cache when reading from a slow network. This path map point to the local drive location for that cache.

– **LuaModules**: Location for Lua Scripting modules.

– **LUTs**: Points to the location for user created macros. The macros saved to this location appear in the macros category of the Effects Library and in the right-click Edit Macro contextual menu.

– **Plugins**: This refers to user specific OpenFX plug-ins that you do not want loaded for all users.

– **Previews**: Path map used for the older style, file sequence flipbook previews.

– **Queues**: Location of the Render manager list.

– **Scripts**: Location of Lua and Python scripts. This path can be further refined into specific scripts for tools (nodes), comps, and other specific script types.

– **Settings**: Location where custom Node settings are saved.

– **Stamps**: Location for preview movies generated in a Fusion Studio bin. This is an outdated path map since bins now include the Studio Player.

– **Templates**: Location of the Templates folder. Saving Macros to the Template folder will cause them to appear in the Effects Library in a Templates category. In Fusion Studio, the Templates category does not appear until a Macros is saved into the folder.

– **Thumbs**: Location for clip thumbnails generated in a Fusion Studio bin. This is an outdated path map since bins include now include the Studio Player.

– **UserPaths**: Used for locations of studio- or facility-specific tools, like custom plug-ins and scripts located on a central server.

– **User Path Maps**: User paths are new paths that you have defined that do not currently exist in the Defaults settings.

– **Comp**: Refers to the folder where the current composition is saved. For instance, saving media folders within the same folder as your Fusion Studio comp file is a way to use relative file paths for Loaders instead of actual file paths.

**Modifying a System Path Map**

To modify an existing System path map, select the path map in the System section. Click the folder icon at the bottom of the Preferences window, and enter the name of the path map in the From field below. Enter the value of the path map in the To field.
Modifying a Default Path Map
To modify an existing Default path map, select the path map in the Default section. Click the folder icon at the bottom of the Preferences window, and enter the name of the path map in the From field below. Enter the value of the path map in the To: field.

Creating a User Path Map
To create a path map, click on the New button and enter the name of the path map in the From field below. Enter the value of the path map in the To: field.

Deleting a Path Map
To delete a user-created path map, select it from the list and click the Delete button. System and Default path maps cannot be deleted; only user created path maps can be removed from the Path Maps list.

Nesting Path Maps
When defining your own path map, you can use an existing path map in the new definition. For example, define a path map called ‘Episode’ that maps to MyDrive\ Projects\Episode1. Then create new path maps called Renders and Stills that map to Episode\ Renders_v1 and Episode\ Stills_v1.

Preview
Preview is only available in Fusion Studio. Previews in DaVinci Resolve use the Scratch Disk setting in the Media Storage preferences.

In the Preview preferences, you configure the creation and playback options for preview renders.

The Preview preferences
Options

– **Render Previews Using Proxy Scaling:** When checked, this option scales down the images to the preview size for the Loader and Creator tools. This causes much faster rendering. If this option is disabled, frames will be rendered at full size and are then scaled down.

– **Skip Frames to Maintain Apparent Framerate:** When checked, frames are skipped during playback of Flipbooks and file sequences to maintain the frame rate setting.

– **Show Previews for Active Loaders:** This setting determines whether the preview playback controls are shown below the Inspector when a Loader with a valid file is activated.

– **Show Previews for Active Savers:** This setting determines whether the preview playback controls below the Inspector are shown when a Saver with a valid file is activated.

– **Display File Sequences On:** This setting determines which viewer or external monitor is used for the interactive and file sequence playbacks as well as for the scrubbing function in the bins.

**QuickTime**

The QuickTime preferences are only available in Fusion Studio on macOS. These settings configure the default QuickTime codec settings when you select QuickTime as the rendering file format in the Saver node.

- **Compressor:** This drop-down menu displays the QuickTime codecs available from your computer. Fusion tests each codec when the program is started; therefore, some codecs may not be available if the tests indicate that they are unsuitable for use within Fusion.

- **Quality:** This slider is used to determine the amount of compression to be used by the codec. Higher values produce clearer images but larger files. Not all codecs support the Quality setting.
– **Key Frame Every X Frames**: When checked, the codec will create key frames at specified intervals. Key frames are not compressed in conjunction with previous frames and are, therefore, quicker to seek within the resulting movie. Not all codecs support the key frame setting.

– **Limit Data Rate To X KB/Second**: When checked, the data rates of the rendered file will be limited to the amount specified. Not all codecs support this option. Enter the data rate used to limit the QuickTime in kilobytes (kB) per second, if applicable. This control will have no effect if the Limit Data Rate To option is not selected.

### Script

The preferences for Scripting include a field for passwords used to execute scripts from the command line and applications for use when editing scripts.

![Script preferences](image)

### Login

There are three login options for running scripts outside of the Fusion application.

– **No Login Required to Execute Script**: When enabled, scripts executed from the command line, or scripts that attempt to control remote copies of Fusion, do not need to log in to the workstation in order to run.

– **Specify Custom Login**: If a username and password are assigned, Fusion will refuse to process incoming external script commands (from FusionScript, for example), unless the Script first logs in to the workstation. This only affects scripts that are executed from the command line, or scripts that attempt to control remote copies of Fusion. Scripts executed from within the interface do not need to log in regardless of this setting. For more information, see the Scripting documentation.
– **Use Windows Login Validation:** When using Fusion on Windows, enabling this option verifies the user name and password (also known as credentials) with the operating system before running the script.

**Options**
– **Script Editor:** Use this preference to select an external editor for scripts. This preference is used when selecting Scripts > Edit.

**Python Version**
– Two options are presented here for selecting the version of Python that you plan on using for your scripts.

**Spline Editor**
The Spline Editor preferences allow you to set various spline options for Autosnap behavior, handles, markers, and more. This only affects splines displayed in the Spline Editor, not splines created in the viewer using the polygon tool or paths.
Spline Editor Options
These settings control the spline behavior in the Spline Editor, as well as the appearance of the graph area.

- **Independent Handles**: Enabling this option allows the In or Out direction handle on newly created key frames to be moved independently without affecting the other. This option is also available via the Options submenu when right-clicking in the Spline Editor graph.
- **Follow Active**: The Spline Editor focuses on the currently active tool. This option is also available via the Options submenu when right-clicking in the Spline Editor graph.
- **Show Key Markers**: Small colored triangles will be displayed at the top of the Spline Editor Time Ruler to indicate key frames on active splines. The colors of the triangles match the colors of the splines. This option is also available via the Show submenu when right-clicking in the Spline Editor graph.
- **Show Tips**: Toggles if tooltips are displayed or not. This option is also available via the Show submenu when right-clicking in the Spline Editor graph.
- **Autosnap Points**: When moving points in the Spline Editor, these will snap to the fields or frames or can be moved freely. This option is also available via the Options submenu when right-clicking in the Spline Editor graph.
- **Guides**: When moving points in the Spline Editor, these will snap to guides as well. This option is also available via the Options submenu when right-clicking in the Spline Editor graph.
- **Autosnap Guides**: When moving or creating guides, these will snap to the fields or frames or can be moved freely. This option is also available via the Options submenu when right-clicking in the Spline Editor graph.
- **Autoscale**: Keeps the Spline Editor scales intact on changing the editable spline content of the graph. This scale is also available via the Options submenu when right-clicking in the Spline Editor graph.
- **Scroll**: Scrolls horizontally and vertically to show all or most of the spline points. This option is also available via the Scale submenu when right-clicking in the Spline Editor graph.
- **Fit**: Zooms to fit all points within the spline graph, if necessary. This option is also available via the Scale submenu when right-clicking in the Spline Editor graph.

LUT View Options
LUT splines are not currently available in the Spline Editor, and therefore these options are not operational in the current version.

- **Independent Handles**: Enabling this option allows the In or Out direction handle on newly created key frames to be moved independently without affecting the other.
- **Show Key Markers**: Small colored triangles will be displayed at the top of the Spline Editor Time Ruler to indicate key frames on active splines. The colors of the triangles match the colors of the splines.
- **Show Tips**: Toggles whether tooltips are displayed.
Splines

Options for the handling and smoothing of animation splines, tracker path defaults, and rotoscoping are found in the Splines preferences.

- **Autosmooth**: Automatically smooths out any newly created points or key frames on the splines selected in this section. You can choose to automatically smooth animation splines, B-Splines, polyline matte shapes, LUTs, paths, and meshes.

- **B-Spline Modifier Degree**: This setting determines the degree to which the line segments influence the resulting curvature when B-Splines are used in animation. Cubic B-Splines determine a segment through two control points between the anchor points, and Quadratic B-Splines determine a segment through one control point between the anchor points.

- **B-Spline Polyline Degree**: This setting is like the one above but applies to B-Splines used for masks.

- **Tracker Path Points Visibility**: This setting determines the visibility of the control points on tracker paths. You can show them, hide them, or show them when your cursor hovers over the path, which is the default behavior.

- **Tracker Path**: The default tracker creates Bézier-style spline paths. Two other options in this setting allow you to choose B-Spline or XY Spline paths.

- **Polyline Edit Mode on Done**: This setting determines the state of the Polyline tool after you complete the drawing of a polyline. It can either be set to modify the existing control points on the spline or modify and add new control points to the spline.

- **Onion Skinning**: The Onion Skinning settings determine the number of frames displayed while rotoscoping, allowing you to preview and compare a range of frames. You can also adjust if the preview frames only from the frame prior to the current frame, after the current frames, or split between the two.
Timeline preferences

The Timeline preferences is where you create and edit Keyframes Editor/Spline Editor filters and set default options for the Keyframes Editor.

Filter/Filter to Use

The Filter menu populates the hierarchy area below the menu with that setting. It lets you edit the filters. The Filter to Use menu selects the default filter setting located in the Keyframes Editor Options menu.

Settings for Filters

This area is used to create a new filter and define its settings. You start by first clicking the New button and entering the name of the new Filter. You then select any of the tools that you want the filter to contain. Only tools that are checked will appear in the Keyframes Editor or Spline Editor when the filter is selected. You can also create a copy of the filter using the Copy button or remove a filter from the list by clicking the Delete button.

Timeline Options

The Timeline Options configure which options in the Keyframe Editor are enabled by default. A series of checkboxes correspond to buttons located in the Timeline, allowing you to determine the states of those buttons at the time a new comp is created. For more information on the Keyframes Editor functions, see Chapter 70, “Animating in Fusion’s Keyframes Editor” in the DaVinci Resolve Reference Manual or Chapter 9 in the Fusion Reference Manual.

- Autosnap Points: When moving points in the Keyframes Editor, the points will snap to the fields or to the frames, or they can be moved freely.
– **Guides:** When moving points in the Keyframes Editor, the point will snap to the guides that are placed in the Timeline graph.

– **Autosnap Guides:** When moving or creating guides, the guides will snap to the fields or to the frames, or they can be moved freely.

– **Autoscale:** Keeps the Timeline scales intact while changing the editable spline content in the graph. When set to scroll, the Timeline scrolls horizontally and vertically to show all or most of the spline points when changing the editable spline content in the graph. When set to Fit, the Timeline zooms to fit all points within the graph, if necessary.

– **Tools Display Mode:** This menu controls the default sort order of the tools displayed in the Keyframes Editor. The default can be changed using the Sort order menu in the upper right of the Keyframes Editor.

### Tweaks

The Tweaks preferences handle a collection of settings for fine-tuning Network rendering in Fusion Studio and graphics hardware behavior.

![The Tweaks preferences](image)

#### Network

The Network section is used to control and monitor the health of communication packets over TCP/IP when rendering over a network in Fusion Studio.

– **Maximum Missed Heartbeats:** This setting determines the maximum number of times the network is checked before terminating the communication with a Render node.

– **Heartbeat Interval:** This sets the time between network checks.
– **Load Composition Timeout:** This timeout option determines how long the Render Manager will wait for a composition to load before moving on to another task.

– **Last Slave Restart Timeout:** This timeout option determines how long the Render Manager will wait for a render slave to respond before using another render slave.

### File I/O
The File I/O options are used to control the performance when reading frames or large media files from both direct and networked attached storage.

– **I/O Canceling:** This option enables a feature of the operating system that allows queued operations to be canceled when the function that requested them is stopped. This can improve the responsiveness, particularly when loading large images over a network.

Enabling this option will specifically affect performance while loading and accessing formats that perform a large amount of seeking, such as the TIFF format.

This option has not been tested with every hardware and OS configuration, so it is recommended to enable it only after you have thoroughly tested your hardware and OS configuration using drive loads from both local disks and network shares.

– **Enable Direct Reads:** Enabling this checkbox uses a more efficient method when loading a large chunk of contiguous data into memory by reducing I/O operations. Not every operating system employs this ability, so it may produce unknown behavior.

– **Read Ahead Buffers:** This slider determines the number of 64K buffers that are used to read ahead in a file I/O operation. The more buffers, the more efficient loading frames from disk will be, but the less responsive it will be to changes that require disk access interactively.

### Area Sampling
The Area Sampling options allow you to fine-tune the RAM usage on Render nodes by trading off speed for lower RAM requirements.

– **Automatic Memory Usage:** This checkbox determines how area sampling uses available memory. Area sampling is used for Merges and Transforms. When the checkbox is enabled (default), Fusion will detect available RAM when processing the tool and determine the appropriate trade-off between speed and memory.

If less RAM is available, Fusion will use a higher proxy level internally and take longer to render. The quality of the image is not compromised in any way, just the amount of time it takes to render. In node trees that deal with images larger than 4K, it may be desirable to override the automatic scaling and fix the proxy scale manually. This can preserve RAM for future operations.

– **Pre-Calc Proxy Level:** Deselecting the Automatic Memory will enable the Pre-Calc Proxy Scale slider. Higher values will use less RAM but take much longer to render.

### Open GL
This section controls how Fusion makes use of your graphics card when compositing in 3D with the Renderer 3D node. Most settings may be left as they are, but since OpenGL hardware varies widely in capabilities and different driver revisions can sometimes introduce bugs, these tweaks can be useful if you are experiencing unwanted behavior.

– **Disable View LUT Shaders:** OpenGL shaders can often dramatically accelerate View LUTs, but this can occasionally involve small trade-offs in accuracy. This setting will force Fusion to process LUTs at full accuracy using the CPU instead. Try activating this if View LUTs do not seem to be giving the desired result.
– **Use Float16 Textures:** If your graphics hardware supports 16-bit floating-point textures, activating this option will force int16 and float32 images to be uploaded to the viewer as float16 instead, which may improve playback performance.

– **Texture Depth:** Defines in what depth images are uploaded to the viewer.
  – **Auto:** The Auto option (recommended) lets Fusion choose the best balance of performance and capability.
  – **int8:** Similar to the Use Float16 Textures switch, this option can be used to force images to be uploaded to the Display View as int8, which can be faster but gives less range for View LUT correction.
  – **Native:** The Native option uploads images at their native depth, so no conversion is done.

– **Image Overlay:** The Image Overlay is a viewer control used with Merge and Transform tools to display a translucent overlay of the transformed image. This can be helpful in visualizing the transformation when it is outside the image bounds but may reduce performance when selecting the tool if cache memory is low. There are three settings to choose from: None, Outside, and All.
  – **None:** This setting never displays the translucent overlay or controls, which can reduce the need for background renders, in some cases resulting in a speed up of the display.
  – **Outside:** This will display only those areas of the control that are outside the bounds of the image, which can reduce visual confusion.
  – **All:** Displays all overlays of all selected tools.

– **Smooth Resize:** This setting can disable the viewer’s Smooth Resize behavior when displaying floating-point images. Some older graphics cards are not capable of filtering floating-point textures or may be very slow. If Smooth Resize does not work well with float images, try setting this to flt16 or int.

– **Auto Detect Graphics Memory (MB):** Having Fusion open alongside other OpenGL programs like 3D animation software can lead to a shortage of graphics memory. In those cases, you can manually reduce the amount of memory Fusion is allowed to use on the card. Setting this too low or too high may cause performance or data loss.

– **Use 10-10-10-2 Framebuffer:** If your graphics hardware and monitor support 30-bit color (Nvidia Quadro/AMD Radeon Pro, and some Nvidia GeForce/AMD Radeon), this setting will render viewers with 10 bits per primary accuracy, instead of 8 bits. Banding is greatly reduced when displaying 3D renders or images deeper than 8-bit.

### User Interface

The User Interface preferences set the appearance of the user interface window and how the Inspector is displayed.
The User Interface preferences

Appearance
When enabled, the Use Gray Background Interface checkbox will change the color of the background in Fusion’s panels to a lighter, more neutral shade of gray.

Controls
This group of checkboxes manages how the controls in the Inspector are displayed.

- **Auto Control Open**: When disabled, only the header of the selected node is displayed in the Inspector. You must double-click the header to display the parameters. When enabled, the parameters are automatically displayed when the node is selected.

- **Auto Control Hide**: When enabled, only the parameters for the currently active tool (red outline) will be made visible. Otherwise, all tool headers will be visible and displayed based on the Auto Control Open setting.

- **Auto Control Close Tools**: When enabled, only the active (red outlined) tool in the Node Editor will have controls displayed. Any previous active node’s tools will be closed in the Inspector. When disabled, any number of tools may be opened to display parameters at the same time. This setting has no effect if the Auto Control Hide checkbox is enabled.

- **Auto Control Close Modifiers**: When enabled, only one modifier’s parameters will be displayed for the active node. Any additional modifiers for the active node will show only their header.

- **Auto Control Advance**: If the Auto Control Advanced checkbox is enabled, the Tab key and Return/Enter key will cause the keyboard focus to advance to the next edit box within the Inspector. When disabled, Return/Enter will cause the value entered to be accepted, but the keyboard focus will remain in the same edit box of the control. The Tab key can still be used to advance the keyboard focus.

- **Show Controls for Selected**: When this option is disabled, only the active tool’s parameters are shown in the Inspector. By default, it is enabled, showing controls for the active tool as well as all selected tools.
– **Combined Color Wheel**: When the Color Corrector tool is displayed in the Inspector, enabling this checkbox will show one color wheel with buttons to switch between the master, shadow, midtones, and highlight channels. Otherwise, four color wheels are displayed in the Inspector.

– **Gamma Aware Color Controls**: This setting adjusts color correction nodes when working with Rec. 709 images in a non-color managed project. Rec. 709 images appear correct on the computer monitor because monitors have a gamma adjustment built in. When working in the Rec. 709 color space without color management, enabling Gamma Aware color removes the gamma, applies the color correction as if it were linear, and then reapplies the gamma. For Rec. 709 images, enable the Gamma Aware setting and enter a Gamma value of 2.4. In a color managed linear project, this should be set to Off or a value of 1.0. When dealing with mixed color spaces, Fusion reads the metadata from the image and sets the Aware gamma value based on the metadata available.

– **Grab Distance**: This slider ranges from 1 to 10 and defaults to 5. It designates the active area around the mouse pointer and can be modified if you have difficulties in selecting points for modification in paths and spline curves. Smaller values will require a more accurate selection with the mouse pointer.

**Touch Scrolling and Mouse Wheel**

This group of settings allows you to configure which, if any, keyboard modifiers are needed to pan or zoom a panel when using a trackpad or middle mouse wheel.

**Video Monitoring**

This setting is only available in Fusion Studio. Control over video hardware for the Fusion Page is done in the DaVinci Resolve preferences. The Video Monitoring preferences are used to configure the settings of Blackmagic Design capture and playback products such as DeckLink PCIe cards and UltraStudio i/O units.

The Video Monitoring preferences
Video Output
This group of drop-down menus allows you to select the type of video I/O device you have installed, the output resolution, and the pixel format. These settings have nothing to do with your rendered output; it is only for your display hardware.

The Output HDR over HDMI settings are used to output the necessary metadata when sending high dynamic range signals over HMDI 2.0a and have it correctly decided by an HDR capable video display. The Auto setting detects the image’s values and outputs HDR. This will not affect non HDR images. The Always setting forces HDR on all the time. This can can be useful when checking non HDR and HDR grades.

When Auto or Always is selected, you can then set the “nit” level (slang for cd/m²) to whatever peak luminance level your HDMI connected HDR display is capable of.

Stereo Mode
This group of settings configures the output hardware for displaying stereo 3D content.

– Mono will output a single non stereo eye.
– Auto will detect which method with which the stereo images are stacked.
– Use the Vstack option if the stereo images are stacked vertically as left on top and right at the bottom.
– Use the Hstack option if the stereo images are stacked horizontally as left and right.

The Swap eyes checkbox will swap the eyes if stereo is reversed.

View
The View preferences are used to manage settings and default controls for viewers.
Saved View Settings
The area at the top of the view preferences lists the currently saved settings that you create from the viewer’s contextual menu. You can use the Rename and Delete buttons to manage the selected entries in the list. For more information on the viewer and its contextual menu, see Chapter 68 “Using Viewers” in the DaVinci Resolve Reference Manual or Chapter 7 in the Fusion Reference Manual.

Settings for View
Each viewer has its own preferences. The Settings for View drop-down menu is used to select the viewer you want to configure.

Control Colors
The Control Colors setting allows you to determine the color of the active/inactive onscreen controls.

Color Picking Area Size
You can use these width/height controls to set the number of pixels sampled when using the Color Picker in the viewers.

Displayed Depth Range
The Displayed Depth Range setting controls the view normalization of the Z-Channel.

Fit Margin
The Fit Margin setting determines how much padding is left around the frame when the Fit button is pressed or Fit is selected from the viewer’s contextual menu.

Display LUT Plug-Ins
This list shows the available display LUTs and activates the selected one as default.

VR Headsets
The VR Headsets preferences allow configuration of any connected Virtual Reality headsets, including how stereo and 3D scenes are viewed.
Headset Options
The Headset options are used to select the type of VR headset you are using to view the composite as well as the video layout of the 360° view.

**API**
- **Disabled**: Disabled turns off and hides all usage of headsets.
- **Auto**: Auto will detect which headset is plugged in.
- **Oculus**: Oculus will set the VR output to the Oculus headset.
- **OpenVR**: OpenVR will support a number of VR headsets like the HTC Vive.

**360° Video Format**
- **Auto**: Auto will detect the incoming image layout from the metadata and image frame aspect.
- **VCross and HCross**: VCross and HCross are the six square faces of a cube laid out in a cross, vertical or horizontal, with the forward view in the center of the cross, in a 3:4 or 4:3 image.
- **VStrip and HStrip**: VStrip and HStrip are the six square faces of a cube laid vertically or horizontally in a line, ordered as Left, Right, Up, Down, Back, Front (+X, -X, +Y, -Y, +Z, -Z), in a 1:6 or 6:1 image.
- **LatLong**: LatLong is a single 2:1 image in equirectangular mapping.
- **Enable Mirror Window**: Enable Mirror Window will show a window displaying the headset user’s live view.

**Stereo**
Similar to normal viewer options for stereo 3D comps, these preferences control how a stereo 3D comp is displayed in a VR headset.

**Mode**
- **Mono**: Mono will output a single non stereo eye.
- **Auto**: Auto will detect the method with which the stereo images are stacked.
- **Vstack**: Vstack stereo images are stacked vertically as left on top and right at the bottom.
- **Hstack**: Hstack stereo images are stacked horizontally as left and right.
- **Swap Eyes**: Swap eyes will swap the eyes if stereo is reversed.

**3D**
Similar to normal viewer options for 3D comps, these preferences control how a 3D comp is displayed in a VR headset.

**Lighting**
- **Disabled** lighting is off.
- **Auto** will detect if lighting is on in the view.
- **On** will force lighting on in the VR view.

**Sort Method**
- **Z buffer** sorting is the fast OpenGL method of sorting polygons.
- **Quick Sort** will sort the depth of polygons to get better transparency rendering.
- **Full Sort** will use a robust sort and render method to render transparency.
- **Shadows** can be on or off.
- **Show Matte Objects** will make matte objects visible in view or invisible.
**Bins/Security**

Bins preferences are only available in Fusion Studio. These preferences are used to manage the Bin users and their permissions.

![Bins Security Preferences](image)

**Users List**

The Users List is a list of the users and their permissions. You can select one of the entries to edit their settings using the User and Password edit boxes.

- **Add**: The Add button is used to add a new user to the list by entering a username and password.
- **Remove**: Click this button to remove the selected entry.

**User**

This editable field shows the username for the selected Bin Server item. If the username is unknown, try “Guest” with no password.

**Password**

Use this field to enter the password for the Bin user entered in the Users list.

**Permissions**

The administrator can set up different permission types for users.

- **Read**: This will allow the user to have read-only permission for the bins.
- **Create**: This will allow the user to create new bins.
- **Admin**: This gives the user full control over the bins system.
- **Modify**: This allows the user to modify existing bins.
- **Delete**: This allows the user to remove bins.
Bins/Server

These preferences are used to add Bin Servers to the list of bins Fusion will display in the Bins dialog.

Servers
This dialog lists the servers that are currently in the connection list. You can select one of the entries to edit its settings.

- **Add**: Use this button to add a new server to the list.
- **Remove**: Click this button to remove the selected entry.

Server
This editable field shows the name or IP address of the server for the selected entry in the list.

User
This editable dialog shows the username for the selected Bin Server item.

Password
Use this field to enter the password for the server entered in the Server list.

Library
The Library field lets you name the bins. If you wanted to create a bin for individual projects, you would name it in the Library field and each project would get its own bin.

Application
The Application field allows larger studios to specify some other program to serve out the Bin requests.
Bins/Settings

These preferences are used to control the default behavior of bins.

Stamp Quality
The Stamp Quality is a percentage slider that determines the compression ratio used for Stamp thumbnail creation. Higher values offer better quality but take up more space.

Stamp Format
This drop-down list determines whether the Stamp thumbnails will be saved as compressed or uncompressed.

Options
- **Open Bins on Startup:** When Open Bins on Startup is checked, the bins will open automatically when Fusion is launched.
- **Checker Underlay:** When the Checker Underlay is enabled, a checkerboard background is used for clips with alpha channels. When disabled, a gray background matching the Bin window is used as the clip's background.
EDL Import

The EDL Import options are used to determine how compositions are created from imported CMX-formatted EDL files.

The EDL Import preferences

Flow Format

This drop-down menu provides three options that determine how the node tree is constructed for the imported EDL file.

- **Loader Per Clip**: A Loader will be created for each clip in the EDL file.
- **A-B Roll**: A node tree with a Dissolve tool will be created automatically.
- **Loader Per Transition**: A Loader with a Clip list will be created, representing the imported EDL list.

Use Shot Names

When checked, shot names stored in the EDL file are used to locate the footage.
Customization

The following section covers the customization of preferences that are not technically part of the Preferences window. Using Fusion Studio’s Hotkey Manager window, you can customize the keyboard shortcuts, making the entire process of working in Fusion not only faster but potentially more familiar if you are migrating from another software application. You can also customize Fusion with environment variables to switch between different preferences files, allowing different working setups based on different users or job types. Both of these customization options are only available in Fusion Studio.

Shortcuts Customization

Keyboard shortcuts can be customized in Fusion Studio. You can access the Hotkey Manager by choosing Customize HotKeys from the View menu.

Fusion has active windows to focus attention on those areas of the interface, like the Node Editor, the viewers, and the Inspector. When selected, a gray border line will outline that section. The shortcuts for those sections will work only if the region is active. For example, Command-F in the View will scale the image to fit the view area; in the Flow view, Command-F will open the Find tool dialog; and in the Spline editor, it will fit the splines to the window.

On the right is a hierarchy tree of each section of Fusion and a list of currently set hotkeys. By choosing New or Edit, another dialog will appear, which will give specific control over that hotkey.
Creating a new keyframe will give you the key combo to press, and this Edit Hotkey dialog will appear where the Action can be defined at top right: pressed, repeated, or released. The Name and abbreviated Short Name can be set, as can the Arguments of the action.

**Customizing Preferences**

Fusion Studio's preferences configure Fusion's overall application default settings and settings for each new composition. Although you access and set these preferences through the Preferences window, Fusion saves them in a simple text format called Fusionprefs.

These default preferences are located in a Profiles\Default folder and shared by all Fusion users on the computer. However, you may want to allow each user to have separate preferences and settings, and this requires saving the preferences to different locations based on a user login.

To change the saved location of the preferences file requires the use of environment variables.

**Setting the Preferences Location**

When you first open Fusion, the environment variable FUSION_PROFILE_DIR defines the folder that contains the Profiles folder. If this variable defines a valid path, then the preferences are saved to this folder. If the FUSION_PROFILE_DIR does not exist, then Fusion attempts to create it. If it cannot create the path, then the preferences are stored in the default Path Map location: AllData\Profiles.

Typically, all users share the same preferences. If you want each user to save separate preferences within their home folder, you must create another environment variable with the name FUSION_PROFILE (e.g., FUSION_PROFILE=jane). Using this second environment variable, Fusion will look for the preferences in the PROFILE_DIR of the user profile. Using a login script, you can make sure the FUSION_PROFILE is set to the name of the logged in user.

**Creating a Master Preferences File**

When working with multiple Fusion users in a studio, you may want to standardize on a few settings. Using the FUSION_MasterPrefs environment variable, you can create one or more site-wide preferences in addition to your local personal preferences.

FUSION_MasterPrefs must contain the full path to at least one preferences file. If you have multiple preferences paths, separate them using semicolons. Fusion does not write to these prefs files, and they may contain a subset of all available settings. You may change settings in these files and use them only where local prefs do not already exist unless you set the Locked flag.

**Locking Preferences**

If the line “Locked = true,” appears in the main table of a master file, all settings in that file are locked and override any other preferences. Locked preferences cannot be altered by the user.
Chapter 77

Controlling Image Processing and Resolution

This chapter covers the overall image-processing pipeline. It discusses color bit-depth and how to control the output resolution in a resolution-independent environment.

Contents

Fusion’s Place in the DaVinci Resolve Image-Processing Pipeline 1364
Source Media into the Fusion Page 1364
Forcing Effects into the Fusion Page 1364
Output from the Fusion Page to the Color Page 1365
What Viewers Show in Different DaVinci Resolve Pages 1365
Managing Resolution In Fusion 1365
Changing the Resolution of a Clip 1366
Compositing with Different-Resolution Clips 1366
Sizing Between DaVinci Resolve Pages 1367
Color Bit Depths 1367
Understanding Integer vs. Float 1367
Setting Color Depth in Fusion Studio 1368
Combining Images with Different Color Depths 1369
Advantages of Floating-Point Processing 1370
Fusion’s Place in the DaVinci Resolve Image-Processing Pipeline

When working in a single unified environment like DaVinci Resolve, it is important to understand the order of operations among the pages. DaVinci Resolve exposes some of this via the order of the page buttons at the bottom of the screen, with the Media, Cut, and Edit page at the beginning of the chain and the Color, Fairlight, and Deliver page at the end. However, this isn’t the whole story, especially when it comes to the Fusion page. The following sections describe where the Fusion page fits in the image-processing chain of DaVinci Resolve.

Source Media into the Fusion Page

For ordinary, single clips coming in from the Edit or Cut page, the MediaIn node in the Fusion page represents the source media, as modified by the Clip Attributes window. Although you select the clip from the Edit or Cut page Timeline, in the Fusion page, the clip is accessed from the Media Pool.

**TIP:** The decoding or debayering of RAW files occurs prior to all other operations, and as such, any RAW adjustments will be displayed correctly in the Fusion page.

This means you have access to the entire source clip in the Fusion page, but the render range is set to match the duration of the clip in the Timeline. You also use the full resolution of the source clip, even if the Timeline is set to a lower resolution. However, none of the Edit or Cut page Inspector adjustments carry over into the Fusion page, with the exception of the Lens Correction adjustment.

When you make Zoom, Position, Crop, or Stabilization changes in the Edit or Cut page, they are not visible in the Fusion page. The same applies to any Resolve FX or OpenFX third-party plug-ins. If you add these items to a clip in the Edit or Cut page, and then you open the Fusion page, you won’t see them taking effect. All Edit and Cut page timeline effects and Inspector adjustments, with the exception of the Lens Correction adjustment, are computed after the Fusion page but before the Color page. If you open the Color page, you’ll see the Edit and Cut page transforms and plug-ins applied to that clip, effectively as an operation before the grading adjustments and effects you apply in the Color page Node Editor.

With this in mind, the order of effects processing in the different pages of DaVinci Resolve can be described as follows:

**TIP:** Retiming applied to the clip in the Edit page Timeline is also not carried over into the Fusion page.

Forcing Effects into the Fusion Page

There is a way you can force clips with Edit page Inspector adjustments, plug-ins, retiming, and Color page grades into the Fusion page, and that is to turn that clip into a compound clip. When Edit page effects and Color page grading are embedded within compound clips, MediaIn nodes corresponding to compound clips route the effected clip into the Fusion page. However, bringing a compound clip into the Fusion page does change the resolution of the source clip to match the Timeline resolution. For more information, see the section “Sizing Between DaVinci Resolve Pages” in this chapter.
Output from the Fusion Page to the Color Page

The composition output from the Fusion page’s MediaOut node are passed on via the Color page’s source input, with the sole exception that if you’ve added plug-ins to that clip in the Edit or Cut page, then the handoff from the Fusion page to the Color page is as follows:

What Viewers Show in Different DaVinci Resolve Pages

Owing to the different needs of compositing artists, editors, and colorists, the viewers show different states of the clip.

- **The Edit page source viewer**: Always shows the source media, unless you’re opening a compound clip that’s been saved in the Media Pool. If Resolve Color Management is enabled, then the Edit page source viewer shows the source media at the Timeline color space and gamma.

- **The Edit page Timeline viewer**: Shows clips with all Edit page effects, Color page grades, and Fusion page effects applied, so editors see the program within the context of all effects and grading.

- **The Fusion page viewer**: Shows Media Pool source clips at the Timeline color space and gamma, but no Edit page Inspector adjustments or Resolve FX effects and no Color page grades.

- **The Color page viewer**: Shows clips with all Edit page effects, Color page grades, and Fusion page effects applied.

Managing Resolution In Fusion

There is no formal resolution to a comp in Fusion. Even though opening Fusion > Fusion Settings in the Fusion page or Preferences in Fusion Studio allows you to set the Width and Height in the Frame Format panel, those settings only affect the size of Fusion-generated images, like the Background tool, Fast Noise, and Text+ tool. The actual resolution of your composition is initially determined by the source resolution of the input image. However, it can be modified at any time using a variety of operations and nodes. For example, if you read in a full HD 1920 x 1080 resolution image, your comp starts at full HD 1920 x 1080 resolution. This is regardless of the Timeline resolution when you are using the Fusion page in DaVinci Resolve. The initial resolution of the Fusion comp is the size of the source media. Depending on how you combine images and the nodes you use, the output comp resolution can be maintained or modified.

**TIP**: The output of the Fusion page is placed back into the Edit page Timeline based on DaVinci Resolve’s Image Sizing setting. By default, DaVinci Resolve uses an image sizing setting called Scale to Fit. This means that even if the Fusion page outputs a 4K composition, it conforms to 1920 x 1080 if that is what the project or a particular Timeline is set to. Changing the image sizing setting in DaVinci Resolve’s Project Settings affects how Fusion compositions are integrated into the Edit page Timeline.
Changing the Resolution of a Clip

If your comp uses a single image, you can change the pixel output resolution in several ways. Three common tools that change the pixel resolution of a clip are the Resize, Scale, and Crop nodes. A fourth node, Letterbox, is less commonly used but also changes the pixel resolution of a clip.

These four nodes are located in the Transform category of the Effects library. Resize is also located in the toolbar.

- **Crop**: Sets the output resolution of the node using a combination of X and Y size along with X and Y offset to cut the frame down to the size you want. Crop removes pixels from the image, so if you later use a Transform node and try to move the image, those pixels are not available.

- **Letterbox**: Sets the output resolution of the node by adding horizontal or vertical black edges where necessary to format the frame size and aspect ratio.

- **Resize**: Sets the output resolution of the node using absolute pixels.

- **Scale**: Sets the output resolution of the node using a relative percentage of the current input image size.

**TIP**: To change resolution and reposition a frame without changing the pixel resolution of a clip, use the Transform node.

Compositing with Different-Resolution Clips

When you composite images with different resolutions using the Merge node, the image that’s connected to the orange background input determines the output resolution of the Merge node.

Often, it’s easiest to control the comp resolution right at the start by connecting a node with the desired output resolution you want to the orange background input on the Merge node. A Background node is often used in this situation because it consumes meager system resources.

A Background node determines the output resolution of the merge

The Background node sets the output size, and the foreground image is cropped if it is larger.

A Background node created at 1280 x 720 crops the larger foreground. However, all the pixels of the larger foreground are available for repositioning.
Sizing Between DaVinci Resolve Pages

The order of sizing operations between DaVinci Resolve pages is a bit more nuanced. It’s important to understand which sizing operations happen in the Fusion page, and which happen after, so you know which effects alter the image that’s input to the Fusion page, and which effects alter the page’s output. For example, lens correction, while not strictly sizing, is nonetheless an effect that changes how the image begins in your Fusion composition. However, the Edit or Cut page stabilization function is an effect that comes after the Fusion page, so it does not appear in the composition you’re creating.

The order of sizing effects in the different pages of DaVinci Resolve can be described as follows:

1. **Super Scale**
2. **Edit/Cut Page Lens Correction**
3. **Fusion Transforms**
4. **Edit/Cut Page Transforms**
5. **Input Sizing**
6. **Output Sizing**

Sizing with Compound and Fusion Clips

Another way to modify the resolution before clips get handed off from the Edit page to the Fusion page is to create a compound clip or a Fusion clip. Both compound clips and Fusion clips change the working resolution of the individual clips to match the Timeline resolution. For instance, if two 4K clips are stacked one on top of the other in an HD timeline, creating a compound or Fusion clip resizes the clips to HD. The full resolution of the individual 4K clips is not available in Fusion and is therefore handed off to the Color page at the rescaled size. To maintain the full resolution of source clips, bring only one clip into the Fusion page from the Edit or Cut page Timeline, and then bring other clips into the Fusion composition using the Media Pool. Of course, if your clips are full HD and your timeline is full HD, then creating a Fusion clip or compound clip does not affect the resolution.

Color Bit Depths

The term bit depth describes how many colors are available in the color palette used to make up an image. The higher the bit depth, the greater the precision of color in the image, and therefore the greater the color reproduction. The higher precision is most apparent in gradients with subtle changes. Lower bit-depth gradients have noticeable banding artifacts, whereas higher bit-depth images can reproduce more colors, so fewer, if any, banding artifacts occur. The Fusion page within DaVinci Resolve always uses 32-bit float bits per channel precision to process images. However, in Fusion Studio you can choose to process images with 8-bit integer, 16-bit integer, 16-bit float, and 32-bit float bits per channel. Although always working at 16-bit float or 32-bit float will produce the best quality, it may be more efficient to use a lower bit depth if your images are 8-bit or 16-bit integer formats to begin with.

Understanding Integer vs. Float

Generally, 8-bit integer color processing is the lowest bit depth you’ll come across for video formats. 8-bit images come from older or consumer-grade video equipment like mobile phones and camcorders. If you try to perform any significant gamma or color correction on 8-bit images, you can often see more visible banding.

16-bit integer color depth doubles the amount of precision, eliminating problems with banding. Although you can select 16-bit integer processing for an 8-bit clip, it does not reduce banding that already exists in the original file. Still, it can help when adding additional effects to the clip. This sounds like the best solution until you realize that many digital cameras like Blackmagic Design URSA Mini Pro and others record in formats that can capture over-range values with shadow areas below 0.0 and super highlights above 1.0, which are truncated in 16-bit integer.
The 16-bit float color depth sacrifices a small amount of the precision from standard 16-bit integer color depth to allow storage of color values less than 0 and greater than 1.0. 16-bit float, sometimes called half-float, is most often found in the OpenEXR format and contains more than enough dynamic range for most film and HDR television purposes yet requires significantly less memory and processing time than is required for full float, 32-bit images.

Preserving over-range values allows you to change exposure while maintaining highlights.

Processing at 32-bit float can work with shadow areas below 0.0 and highlights above 1.0, similar to 16-bit float, except with a much greater range of precision but also much greater memory and processing requirements.

**Setting Color Depth in Fusion Studio**

As we said earlier, DaVinci Resolve always processes at 32-bit float bits per channel; however, you can use less memory and still achieve more-than-acceptable results using the Performance Mode setting located in the User > Playback Preferences panel.

Fusion Studio automatically uses the color depth that makes the most sense for each file format. For example, if you read in a JPEG file from disk, then the color depth for the Loader is set to 8 bits per channel. Since the JPEG format is an 8-bit format, loading the image at a greater color depth would generally be wasteful. If a 16-bit TIFF is loaded, the color depth is set to 16 bits. Loading a DPX file defaults to 32-bit float, whereas OpenEXR generally defaults to 16-bit float. However, you can override the automatic format color depth using the settings found in the Import tab of the Loader node’s Inspector. The Loader’s Inspector, as well as the Inspector for images generated in Fusion (i.e., text, gradients, fast noise, and others), has a Depth menu for 8-bit, 16-bit integer, 16-bit float, and 32-bit float.

**Configuring Default Color Depth Preferences**

The default color depth setting forces the tool to process based on the settings configured in the Node Editor’s Frame Format preferences. These are used to set a default value for color depth, applied when a Generator tool is added to the Node Editor. There are three drop-down menus to
configure color depth in the preferences. They specify the different color depths for the interactive session, final renders, and preview renders.

To improve performance as you work on your comp, you can set the Interactive and Preview depth to 8-bits per channel, while final renders can be set to 16-bit integer. However, if your final render output is 16-bit float or 32-bit float, you should not use the integer options for the interactive setting. The final results may look significantly different from interactive previews set to integer options.

The Frame Format Color Depth settings

If you aren’t sure what the color depth process is for a tool, you can position the pointer over the node’s tile in the Node Editor, and a tooltip listing the color depth for that node will appear on the Status bar.

Hover over a node to view its Color Bit Depth setting.

**TIP:** When working with images that use 10-bit or 12-bit dynamic range or greater, like Blackmagic RAW or Cinema DNG files, set the Depth menu in the Inspector to 16-bit float or 32-bit float. This preserves highlight detail as you composite.

**Combining Images with Different Color Depths**

You can combine images with different color depths in a single composition. When images of different color depths are combined, the image from the background input of the node determines the bit depth output, and the foreground image is adjusted to match.
Advantages of Floating-Point Processing

There are two major advantages to floating-point processing that make the additional RAM requirements and longer render times worth your while. The first benefit is that floating-point values are more accurate than integer values. The second benefit is the preservation of shadow and highlight values that go beyond the normal tonal range.

Greater Accuracy

Using 16- or 32-bit floating-point processing prevents the loss of accuracy that can occur when using 8- or 16-bit integer processing. The main difference is that integer values cannot store fractional or decimal values, so rounding occurs in all image processing. Floating-point processing allows decimal or fractional values for each pixel, so it is not required to round off the values of the pixel to the closest integer. As a result, color precision remains virtually perfect, regardless of how many operations are applied to an image.

Greater Accuracy

If you have an 8-bit pixel with a red value of 75 (dark red) and that pixel is halved using a Color Correction tool, the pixel’s red value is now 37.5. Since you cannot store decimal or fractional values in integers, that value is rounded off to 37. Doubling the brightness of the pixel with another Color Correction tool should bring back the original pixel value of 75 but because of rounding 37 x 2 is 74. The red value lost a full point of precision due to integer rounding on a very simple example. This is a problem that can result in visible banding over several color corrections. Similar problems arise when merging images or transforming them. The more operations that are applied to an image, the more color precision is lost to rounding when using 8- or 16-bit integer processing.

Accessing Extended Highlights and Shadows

Increasingly more productions are capturing out-of-range images thanks to digital cinema cameras like the Blackmagic URSA Mini Pro and even the Pocket Cinema 6K camera. These cameras capture very high dynamic range RAW images and maintain color detail even in heavily over or underexposed frames. The extended white color detail can also give very nice, natural results when blurred, glowing, color corrected, or even just when faded or dissolved. While it is possible to work with these RAW images using integer data, doing so results in the loss of the extended range values, losing all detail in the highlights and shadows. Float processing makes working with logarithmic RAW images considerably easier by preserving highlight and shadow detail.

Accessing Extended Highlights and Shadows

If you have an 8-bit pixel that has a red value of 200 (bright red) and a Color Gain tool is used to double the brightness of the red channel, the result is 200 x 2, or 400. However, 8-bit color values are limited to a range of 0 through 255. So the pixel’s value is clipped to 255, or pure red. If now the brightness is halved, the result is half of 255, or 127 (rounded), instead of the original value of 200.

When processing floating-point colors, pixel values brighter than white or darker than black are maintained. There is no value clipping. The pixel is still shown in the viewer as pure red, but if float processing is used instead of 8-bit, the second operation where the gain was halved would have restored the pixel to its original value of 200.

Using Float with 8-Bit HD Video

There is also some value to using float color depths with an 8-bit HD video when the images require a lot of color correction. Using float helps maintain precision by avoiding the rounding errors common to 8-bit processing, as described above.

Detecting Extended Highlight and Shadow Values

Although floating-point processing preserves extended values below 0.0 and greater than 1.0, also called “out-of-range values,” the viewer still displays them as black or white. This can make it difficult for you to determine the overall dynamic range of an image.
To discover whether there are out-of-range values in a viewed image:
- Right-click in the viewer and choose Options > Show Full Color Range.

Enabling this display mode rescales the color values in the image so that the brightest color in the image is remapped to a value of 1.0 (white), and the darkest is remapped to 0.0 (black).

The 3D Histogram subview can also help visualize out-of-range colors in an image. For more information, see Chapter 68, “Using Viewers” in the DaVinci Resolve Reference Manual, or Chapter 7 in the Fusion Reference Manual.

Clipping Out-of-Range Values

When processing in floating point, there may be situations where the out-of-range values in an image need to be clipped. The Brightness/Contrast tool provides checkboxes that can be used to clip out-of-range values to 0 or 1.

For example, there may be files that contain out-of-range alpha values. Since the alpha channel represents the opacity of a pixel, it makes little sense to be more than completely transparent or more than fully opaque, and compositing such an image may lead to unexpected results. To easily clip alpha values below 0 and above 1, add a Brightness/Contrast toolset to Clip Black and Clip White, with only the Alpha checkbox selected.

Alternatively, you can clip the range by adding a Change Depth node and switching to 8-bit or 16-bit integer color depths.
Chapter 78

Managing Color for Visual Effects

This chapter discusses LUTs, color space conversions, and the value of compositing with linear gamma while previewing the image in the viewer using the gamma of your choice.

Contents

Color Management 1373
All Compositing Is Math 1373
Introducing Color Management in Fusion 1374
Converting to Linear Gamma 1374
Applying LUTs to a Viewer 1377
Using Resolve Color Management 1379
Using ACES Color Management in Resolve 1380
Using OCIO for ACES Color Management in Fusion 1381
Applying OCIO LUTs in the Viewer 1382
Color Management

The simplified goal of color management is to make sure that the image you see on your computer screen is what your audience sees when they view it on a television, cinema screen, or mobile device. For such a simple goal, problems arise that you, as the compositor, must manage. These problems begin with the fact that our eyes see luminance one way, and a computer display represents luminance differently.

Each capture device records images using a nonlinear tonal curve or gamma curve to compensate for this difference. Specifically, Rec. 709 HD gamma curves are designed so that when shown on HD displays, the images have built-in compensation for the display. The result is that HD images on HD displays appear normal to us.

Digital cinema cameras have taken the concept of gamma curves further. They use gamma curves as a way to maximize the bit depth of an image and store a wider dynamic range. Digital cinema cameras’ gamma curve (often collectively referred to as log gamma), give more attention to the darker mid-tones where the human eye is most sensitive. This allows them to save images with brighter highlights and more detail in shadows.

The problem is that these images do not look normal on any monitor. Clips recorded with a log gamma curve typically have a low contrast, low saturated appearance when viewed on an sRGB computer display or Rec. 709 HD video monitor. This problem is easy to fix using a LookUp Table, or LUT. A LUT is a form of gamma and color correction applied to the viewer to normalize how the image is displayed on your screen.

All Compositing Is Math

The LUT applied to the viewer only solves the problem in the viewer. Now we come to the larger problem. The image data is still using a log gamma curve. Fusion, and every other image-processing application, operates with the assumption that the image data has linear gamma. The image-processing filters you apply to images use standard math functions, like $1 + 1 = 2$. Common operations such as those that add pixels like Brightness, or divide pixels (a.k.a. “unpremultiply”), or composite
modes that include multiplication such as "screen," and many other compositing tasks assume that $1 + 1$ always equals 2. In other words, if you perform an operation that doubles the amount of brightness, then every pixel should be twice as bright. However, if you are starting with a nonlinear gamma curve, pixels are not being adjusted linearly, so some pixels might end up 1.2 x as bright, 1.7 x as bright, or 2.4 x as bright. Now the math is $1 + 1 = 3$. The further your images are from linear gamma, the more pronounced the math error. A Rec. 709 HD clip shows less error than a log gamma clip from a digital cinema camera. However, an error is still an error, and the more compositing operations you perform on the image, the more the error is compounded.

You can see a more practical example when you apply filtering effects, such as a blur, to an image with any gamma setting. The image probably looks fine. However, if you convert the image to a linear gamma first and then apply the blur, the images (especially those with extremely bright areas) are processed with greater accuracy, and you should notice a different and superior result.

The answer to these problems is to manage your color before compositing.

**Introducing Color Management in Fusion**

Images loaded into Fusion by default are not color managed. The image is displayed directly from the file to the viewer without any interpretation or conversion. However, Fusion includes nodes that convert the output of each image to linear gamma at the beginning of your composite. The same nodes can convert from linear back to your desired output gamma at the end of your composite, just prior to the Saver or MediaOut node.

![A log clip converted to linear and then converted for output](image)

**To manually set up a linear gamma workflow in Fusion:**

1. Use a Gamut or CineonLog node after all MediaIn or Loader nodes to convert them to linear.
2. Apply a GAMUT View LUT to the viewers to correct the display of a linear image to sRGB or Rec. 709.
3. Before a Saver or MediaOut node, insert a Gamut or CineonLog node to convert from linear to your target output format.

**Converting to Linear Gamma**

Whether an image comes from the Edit page in DaVinci Resolve, or from a Loader in Fusion Studio, the color and gamma are read directly into Fusion, with no modification. For some simple operations on sRGB or Rec 709 clips, this may be fine, but it’s not always the ideal way to work, especially for log-encoded media. The ideal way to work with log-encoded media is to convert images to linear gamma, since the majority of image-processing operations in Fusion expect gamma to be linear and will produce superior results.

**TIP:** 3D rendered CGI images are often generated as EXR files with linear gamma, and converting them is not necessary. However, you should check your specific files to make sure they are using linear gamma.
Fusion includes several kinds of nodes you can use to convert the image out of each MediaIn or Loader node to linear gamma at the beginning of your composite, and then convert from linear back to your desired output gamma at the end of your composite. These include:

- **CineonLog node**: The CineonLog node, found in the Film category of the Effects Library, performs a conversion from any of the formats in the Log Type menu to linear, and also reverses the process, adding log gamma back to a clip. This is most often used for images coming from common digital cinema cameras like BlackMagic Design, Arri, or Red. The CineonLog node is added directly after a MediaIn or Loader node. The Mode menu chooses the direction of the conversion to or from linear.

- **Gamut node**: The Gamut node, found in the Color category of the Effects Library, lets you perform linear conversions based on color space. This node converts to linear or from linear and is often inserted after a MediaIn or Loader node or just before a MediaOut or Saver node. Depending on where you insert the node, you either choose from the Source Space controls or the Output Space controls.

When converting media to linear gamma, set the Source Space menu to the color space of your source material. For instance, if your media is full 1080 HD ProRes, then choose ITU-R BT.709 (scene) for gamma of 2.4. Then, enable the Remove Gamma checkbox if it isn’t already enabled, to use linear gamma.
When converting from linear gamma for output, you insert the Gamut node before your output node, which is a Saver in Fusion Studio or a MediaOut node in DaVinci Resolve’s Fusion page. Make sure the Source Space menu is set to No Change, and set the Output Space to your output color space. For instance, if your desired output is full 1080 HD, then choose either sRGB or ITU-R BT.709 (scene) for gamma of 2.4. Then, enable the Add Gamma checkbox if it isn’t already enabled, to format the output of the Gamut node for your final output.

Output Space is used to convert from linear gamma.

– **MediaIn and Loader nodes**: MediaIn and Loader nodes have Source Gamma Space controls in the Inspector that let you identify and remove the gamma curve without the need to add another node. If your files include gamma curve metadata like RAW files, the Auto setting for the Curve Type drop-down menu reads the metadata and uses it when removing the gamma curve. When using intermediate files or files that do not include gamma curve metadata, you can choose either log gamma curve by choosing Log from the Curve Type menu or a specific color space using the Space option from the menu. Clicking the Remove Curve checkbox then removes the gamma curve, converting the image to linear gamma.
MediaIn and Loader nodes include a Remove Curve checkbox in the Inspector.

– **FileLUT node:** The FileLUT node, found in the LUT category of the Effects Library, lets you do a conversion using any LUT you want, giving you the option to manually load LUTs in the ALUT3, ITX, 3DL, or CUBE format to perform a gamma and gamut conversion. Although LUTs are very commonly placed at the end of a node tree for final rendering, you’ll get more accurate gamma and color space conversions using the Gamut and CineonLog nodes to transform your MediaIn and Loader nodes into linear.

### Applying LUTs to a Viewer

Images converted to a linear gamma don’t look correct. They usually look very dark, with extremely bright highlights and oversaturated colors. Happily, even though the image may appear to be incorrect, the fact that Fusion can work entirely with floating-point color data means that you’re not actually clipping or losing any image data. It just looks completely wrong when viewing the linear state of your image data directly.

![A clip displayed with a nonlinear, log gamma curve (left) and the clip transformed to linear gamma (right)](image)

It would be impossible to work if you couldn’t view the image as it’s supposed to appear within the final gamut and gamma you’ll be outputting. For this reason, each viewer has a LUT menu that lets you enable a "preview" color space and/or gamma conversion, while the node tree is processing correctly in linear gamma.
Apply a Gamut View LUT to preview the image in your intended output color space.

To preview the images in the viewer using sRGB or Rec. 709 color space:

1. Enable the LUT button above the viewer.
2. From the Viewer LUT drop-down menu, choose either a Gamut View LUT, or a LUT from the VFX IO category that transforms linear to Rec. 709 or sRGB.
3. If you choose the Gamut View LUT, then choose Edit from the bottom of the LUT menu to configure the LUT.
4. In the LUT Editor, set the Output Space to the target color space you want.
5. Enable the Add Gamma checkbox to apply the gamma curve based on the selected color space.

TIP: If your monitor is calibrated differently, you need to select a LUT that matches your calibration.
Whether you use the Gamut View LUT or a LUT for your specific monitor calibration, you can save the viewer setup as the default.

To Save the Gamut LUT setup as the default viewer setup:
- Right-click in the viewer, and then choose Settings > Save Defaults.

For every comp, the viewer will now be preconfigured based on the saved defaults.

For more information on Viewer LUTs, see Chapter 68 “Using Viewers” in the DaVinci Resolve Reference Manual or Chapter 7 in the Fusion Reference Manual.

Using Resolve Color Management

If you’re using the Fusion page within Davinci Resolve, you have the option of enabling DaVinci Resolve’s scene-referred color management, instead of inserting Gamut and CineonLog nodes. When DaVinci YRGB Color Managed (RCM) is enabled, the color of MediaIn nodes in the Fusion page is handled differently. The RCM Timeline color space setting is used for all MediaIn nodes in the Fusion page, which then automatically get converted to linear gamma. The MediaOut node then gets converted back into the Timeline color space to get graded in the Color page or further edited in the Edit page Timeline.

Despite the seeming complexity of color management, using RCM is actually simple. In essence, all you have to do is (A) turn on RCM, (B) assign the appropriate Input Color Space to each clip in the Media Pool based on its recording device, and (C) choose the Timeline and Output Color Space combination you want to use.

To enable Resolve Color Management:
1. Open the Color Management panel of the Project Settings.
2. Choose DaVinci YRGB Color Managed from the Color Science drop-down menu.
3. Choose the Input Color Space for the clips in the Media Pool.
4. Set the desired options for the Timeline Color Space and Output Color Space RCM settings.

To override the input color space for differently recorded clips in the Media Pool:
1. Enable DaVinci YRGB Color Management as explained above.
2. Save and close the Settings dialog.
3. In the Media Pool, select the clip or clips you want to assign a new Input Color space.
4. Right-click one of the selected clips.
5. Choose the Input Color Space that corresponds to those clips from the contextual menu.
Using RCM eliminates a few steps, since the input color space math used to transform the source preserves all wide-latitude image data, making highlights easily retrievable without any extra steps. With RCM enabled, there is no need to insert CineonLog or Gamut nodes while in the Fusion page. The transforms from and to linear are done automatically based on the RCM settings. Switching to the Fusion page converts the images to linear and enables the LUT button in the viewers with the Managed LUT selected. The Managed LUT uses the RCM settings to take a linear image and display it based on the RCM output color space.

For more information on Resolve Color Management, see Chapter 8, “Data Levels, Color Management, and ACES” in the DaVinci Resolve Reference Manual.

Using ACES Color Management in Resolve

The ACES (Academy Color Encoding Specification) color space is another standard for managing color throughout an entire production. It’s designed to make start-to-finish, scene-referred color management a reality for digital cinema workflows. Just like DaVinci’s RCM, ACES makes it easier to extract high-precision, wide-latitude image data from raw camera formats, to preserve high-quality image data from acquisition through the color grading process and to output high-quality data for broadcast viewing, film printing, or digital cinema encoding.

ACES works by assigning an IDT (Input Device Transform) to every camera and acquisition device. The IDT specifies how media from that device is converted into the ACES color space. At the end of the pipeline, an ODT (Output Device Transform) is applied to convert the image data from ACES color space into the gamut of your final output.

Similar to setting up RCM, DaVinci Resolve’s color management project settings can be configured for ACES, which carries through the Edit, Fusion, and Color pages.

NOTE: When using Fusion Studio, the OpenColorIO (OCIO) framework is used for ACES color management.

The Color Science drop-down menu in the Color Management panel of the Project Settings is used to set up the ACES color management in DaVinci Resolve.
– **Color Science:** Using this drop-down menu, you can choose either ACEScc or ACEScct color science. This is primarily a personal preference since they are mostly identical, but the shadows respond differently to grading operations. In the Fusion page, images are automatically converted to linear, so whoever does the grading has more of a reason to choose one or the other.

  – **ACEScc:** Choose ACEScc color science to apply a standard Cineon style log encoding to the ACES data before it is processed by DaVinci Resolve.

  – **ACEScct:** This variation of ACEScc adds a roll-off at the toe of the image to make color correction lift operations “feel” more like they do with film scans and LogC encoded images.

– **ACES Version:** When you’ve chosen one of the ACES color science options, this menu becomes available to let you choose which version of ACES you want to use. As of DaVinci Resolve 16, you can choose either ACES 1.0.3 or ACES 1.1 (the latest version).

– **ACES Input Device Transform:** This menu lets you choose which IDT (Input Device Transform) to use for the dominant media format in use.

– **ACES Output Device Transform:** This menu lets you choose an ODT (Output Device Transform) with which to transform the image data to match your required deliverable.

– **Process Node LUTs In:** This menu lets you choose how you want to process LUTs in the Color page and does not affect the Fusion page.

For more information on ACES within DaVinci Resolve, see Chapter 8, “Data Levels, Color Management and ACES” in the DaVinci Resolve Reference Manual.

### Using OCIO for ACES Color Management in Fusion

When using Fusion Studio or not using color management in DaVinci Resolve, you have the option to use OpenColorIO nodes in Fusion to composite in an ACES color space.

OpenColorIO (OCIO) is an open-source color management framework for visual effects and computer animation. OCIO is compatible with the Academy Color Encoding Specification (ACES). Three OCIO nodes located in the Color category of the Effects Library allow you to use OCIO color space transforms in Fusion.

– **OCIO CDL Transform** node allows you to create, save, load, and apply a Color Decision List (CDL) grade.

– **OCIO Color Space** allows sophisticated color space conversions based on an OCIO config file.

– **OCIO File Transform** allows you to load and apply a variety of LookUp Tables (LUTs).

Using OCIO for converting MediaIn or Loader nodes to linear gamma is based on the OCIO Color Space node. Placing the OCIO Color Space node directly after a Loader (or MediaIn in DaVinci Resolve) displays the OCIO Source and Output controls in the Inspector.
Within the Inspector for OCIO Color Space node, Fusion includes default Source and Output transforms for standard color spaces. However, to use the full OCIO standard, you’ll need to download and install the OCIO config file. You can download the config file from the OCIO website, https://opencolorio.org

Clicking the Browse button in the Inspector will allow you to navigate to the downloaded config file. From the download, locate the ACES 1.0.3 or later folder and select the file config.ocio.

![Source and Output menus are populated based on the config.ocio file that you download.](image)

The Source menu is used to choose the color profile for your Loader or MediaIn node. The default raw setting shows an unaltered image, essentially applying no color management to the clip. The selection you make from the menu is based on the recording profile of your media.

The Output menu is set based on your deliverables. When working in Fusion Studio, typically the Output selected is ACEScg, to work in a scene linear space.

### Applying OCIO LUTs in the Viewer

The viewer also includes OCIO View LUTs to calibrate the viewers. Once the OCIO Color Space View LUT is selected from the LUT menu above the viewer, choosing Edit for the same menu opens a dialog where you can load the OCIO config file.

![The OCIO Color Space View LUT is located in the Viewer LUT menu in Fusion Studio.](image)

By default, the same standard options are available in the View LUT. However, clicking the Browse button allows you to load the same config file you loaded into the OCIO Color Space node. Once loaded, all the expanded OCIO options are available. If you selected the OCIO Color Space node to output ACEScg, you use the OCIO View LUT to go from a source setting of linear sRGB to an output setting of sRGB or Rec. 709 in most cases.
The OCIO Color Space View LUT dialog is used to configure the viewer when using the OCIO Color Space node in the Node Editor.

**TIP:** If your monitor is calibrated differently, you will need to select a LUT that matches your calibration.

**To set the LUT using OCIO:**

1. Click the LUT menu and choose the OCIO Color Space View LUT.
2. From the same menu, select Edit.
3. In the View LUT editor that opens, set the source’s color space to lin sRGB.
4. Set the output space to sRGB or REC 709, assuming you are viewing on a standard computer monitor. You now see a normalized image in the viewer, but all color operations will be on linear images.

Whether you use the OCIO Color Space LUT or a LUT for your specific monitor calibration, you can save the viewer setup as the default.

**To save the OCIO ColorSpace LUT setup as the default viewer setup:**

- Right-click in the viewer, and then choose Settings > Save Defaults. Now, for every comp, the viewer is preconfigured based on the saved defaults.
Chapter 79

Understanding Image Channels

This chapter seeks to demystify how Fusion handles image channels and, in the process, show you how different nodes need to be connected to get the results you expect. It also explains the mysteries of premultiplication, and presents a full explanation of how Fusion is capable of using and even generating auxiliary data.

Contents

Channels in Fusion 1385
Types of Channels Supported by Fusion 1385
Fusion Node Connections Carry Multiple Channels 1386
Node Inputs and Outputs 1387
Node Colors Tell You Which Nodes Go Together 1390
Using Channels in a Composition 1391
Channel Limiting 1392
Adding Alpha Channels 1393
How Channels Propagate During Compositing 1394
Rearranging or Combining Channels 1395
Understanding Premultiplication 1395
The Rules of Premultiplication 1397
Alpha Channel Status in MediaIn and Loader Nodes 1399
Controlling Premultiplication in Color Correction Nodes 1399
Controlling Premultiplication With Alpha Divide and Alpha Multiply 1400
Multi Channel Compositing 1400
Compositing with Beauty Passes 1401
Working with Auxiliary Channels 1406
Channels in Fusion

Fusion introduces some innovative ways of working with the many different channels of image data that modern compositing workflows encompass. This chapter’s introduction to color and data channels and how they’re affected by different nodes and operations is a valuable way to begin the process of learning to do paint, compositing, and effects in Fusion.

If you’re new to compositing, or you’re new to the Fusion workflow, you ignore this chapter at your peril, as it provides a solid foundation to understanding how to predictably control image data as you work in this powerful environment.

Types of Channels Supported by Fusion

Digital images can be divided into separate streams of image data called Channels, each of which carries a specific kind of image data. Nodes that perform different image processing operations typically expect specific channels to provide predictable results. You are probably familiar with the three standard color channels of red, green, and blue, but there are many others. This section describes the different kinds of channels that Fusion supports.

RGB Color channels
The red, green, and blue channels of any still image or movie clip combine additively to represent everything we can see via visible light. Each of these three channels is a grayscale image when seen by itself. When combined additively, these channels represent a full-color image.

Alpha Channels
An alpha channel is an embedded fourth channel that defines different levels of transparency in an RGB image. Alpha channels are typically embedded in RGB images that are generated from computer graphics applications. In Fusion, white denotes solid areas, while black denotes transparent areas. Grayscale values range from more opaque (lighter) to more transparent (darker).

If you’re working with an imported alpha channel from another application for which these conventions are reversed, never fear. Every node capable of using an alpha channel is also capable of inverting it.

Single-Channel Masks
While similar to alpha channels, mask channels are single channel images, external to any RGB image and typically created by Fusion within one of the available Mask nodes. Mask nodes are unique in that they propagate single-channel image data that defines which areas of an image should be solid and which should be transparent. However, masks can also define which parts of an image should be affected by a particular operation, and which should not. Mask channels are designed to be connected to specific mask inputs of nodes including Effect Mask, Garbage Mask, and Solid Mask inputs.
Auxiliary Channels

Auxiliary channels (covered in more detail later in this chapter), describe a family of special-purpose image data that typically expose 3D data in a way that can be used in 2D composites. For example, Z-Depth channels describe the depth of each pixel in an image along a Z axis, while an XYZ Normals channel describes the orientation (facing up, facing down, or facing to the left or right) of each pixel in an image. Auxiliary channel data is generated by rendering 3D images, so it usually accompanies or is embedded with RGB images generated by 3D modeling and animation applications. These channels can also be generated from within Fusion via the Renderer 3D node, which outputs a 3D scene that you’ve assembled and lit as 2D RGBA channels, with optionally accompanying auxiliary channels.

The reason to use auxiliary data is that 3D rendering is computationally expensive and time-consuming, so outputting descriptive information about a 3D image that’s been rendered empowers compositing artists to make sophisticated alterations in 2D. You can add motion blur, perform relighting, and composite with depth information faster than re-rendering the 3D source material over and over.

**TIP:** You can view any of a node’s channels in isolation using the Color drop-down menu in the viewer. Clicking the Color drop-down menu reveals a list of all channels within the currently selected node, including red, green, blue, or auxiliary channels.

Fusion Node Connections Carry Multiple Channels

The connections that pass image data from one node to the next in Fusion’s Node Editor are capable of carrying multiple channels of image data. That means that a single connection may route RGB, or RGBA, or RGBAZ-Depth, or even just Z-Depth, depending on the Input you connect to and the node’s function.

In the following example, the two MediaIn nodes output RGB data. However, the Delta Keyer creates an alpha channel and combined it with MediaIn2’s RGB image. The RGB-A of the Delta Keyer becomes the foreground image that the Merge node can use to create a two-layer composite.

![Diagram of node connections](image)

The alpha channel generated by the Delta key is used for compositing by the foreground input of the Merge node.

**NOTE:** Node trees shown in this chapter may display MediaIn nodes found in DaVinci Resolve’s Fusion page; however, Fusion Studio Loader nodes are interchangeable unless otherwise noted.

Running multiple channels through single connection lines makes Fusion node trees simple to read, but it also means you need to keep track of which nodes process which channels to make sure that you’re directing the intended image data to the correct operations.
Node Inputs and Outputs

By default, MediaIn nodes in the Fusion page and Loader nodes in Fusion Studio output RGBA channels. When you connect one node’s output to another node’s input, the active channels are passed from the upstream node to the downstream node, which then processes the image according to that node’s function. Only one node output can be connected to a node input at a time. In this simple example, a MediaIn node’s output is connected to the input of a Highlight node to create a sparkly highlight effect.

![MediaIn node connected to a Highlight node connected to MediaOut node in the Fusion page.](image)

When connecting nodes, a node’s output carries the same channels no matter how many times the output is “branched.” You cannot send one channel out on one branch and a different channel out on another branch.

![The MediaIn node’s output is branched but carries the same RGB channels to both inputs.](image)

Using Multiple Inputs

Most nodes have two inputs, one for RGBA and another for an effect mask that can be optionally used to limit the effect of that node to a particular part of the image. However, some nodes have three or even more inputs, and it’s important to make sure you connect the correct image data to the appropriate input to obtain the desired result. If you connect one node’s output to another node’s input and nothing happens, chances are you’ve connected to the wrong input.

For example, the MatteControl node has a background input and a foreground input, both of which accept RGBA channels. However, it also has SolidMatte, GarbageMatte, and EffectsMask inputs that accept alpha or mask channels to modify the transparency of the Node’s output. If you want to perform the extremely common operation of using a MatteControl node to create an alpha channel using a Polygon node for rotoscoping an image, you need to make sure that you connect the Polygon node to the GarbageMatte input to obtain the correct result. The GarbageMatte input is automatically set to alter the alpha channel of the foreground image. If you connect to any other input, your Polygon mask may not produce expected results.
In another example, the DeltaKeyer node has a primary input (labeled “Input”) that accepts RGBA channels, but it also has three Matte inputs. These SolidMatte, GarbageMatte, and EffectsMask inputs on the Delta Keyer accept alpha or mask channels to modify the matte being extracted from the image in different ways.

If you position your pointer over any node’s input or output, a tooltip appears in the Tooltip bar at the bottom of the Fusion window, letting you know what that input or output is for, to help guide you to using the right input for the job. If you pause for a moment longer, another tooltip appears in the Node Editor itself.

Connecting to the Correct Input

When you’re connecting nodes, pulling a connection line from the output of one node and dropping it right on top of the body of another node makes a connection to the default input for that node, which is typically the “Input” or “Background” input.
However, if you drop a connection line right on top of a specific input, then you'll connect to that input, so it's important to be mindful of where you drop connection lines as you wire up different node trees together.

Side by side, dropping a connection on a specific node input, note how the inputs rearrange themselves afterwards to keep the node tree tidy-looking.

**TIP:** If you hold the Option key down while you drag a connection line from one node onto another, and you keep the Option key held down while you release the pointer’s button to drop the connection, a menu appears that lets you choose which specific input you want to connect to, by name.

**Inputs Require Specific Channels**

Usually, you're prevented from connecting a node's output to another node or node input that's not compatible with it. For example, if you try to connect a Text3D node's output directly to the input of a regular Merge node, it won’t work; 3D nodes do not produce RGB images, they produce 3D geometry data, so you must first connect to a Renderer3D node that creates the RGB output appropriate for 2D compositing operations.

In other cases, connecting the wrong image data to the wrong node input won’t give you any error, it simply fails to produce the result you were expecting, necessitating you to troubleshoot the composition. If this happens to you, check the Fusion Effects section of this manual to see if the node you're trying to connect to has any limitations as to how it must be attached.

**TIP:** This chapter tries to cover many of the easy-to-miss exceptions to node connection that are important for you to know, so don’t skim too fast.

**Always Connect the Background Input First**

Many nodes combine images in different ways, using “background” and “foreground” inputs. This includes the Merge node, the Matte Control node, and the Channel Booleans node, to cite common examples. The color of inputs on a node can help you make the right corrections. For instance, background inputs are always orange, and foreground inputs are always green.

When you first connect any node’s output to a multi-input node, you usually want to connect the background input first. This is handled for you automatically when you first drop a connection line onto the body of a new multi-input node. The orange-colored background input is almost always connected first (the exception is Mask nodes, which always connect to the first available Mask input). This is good because you want to get into the habit of always connecting the background input first.

If you connect to only one input of a multi-input node and you don’t connect to the background input, you may find that you don’t get the results you wanted. This is because each multi-input node expects that the background is connected before anything else so that the internal connections and math used by that node can be predictable.
**TIP:** The only node to which you can safely connect the foreground input prior to the background input is the Dissolve node, which is a special node that can be used to either dissolve between two inputs, or automatically switch between two inputs of unequal duration.

**Node Colors Tell You Which Nodes Go Together**

Each node in Fusion accomplishes a single type of effect or operation. These single-purpose nodes make it easier to decipher a complex composition when examining its node tree. Single-purpose nodes also make it easier to focus on fine-tuning specific adjustments, one at a time, when assembling an ever-growing tree.

Because each Fusion node has a specific function, they’re categorized by type to make it easier to keep track of which nodes require what types of image channels as input, and what image data you can expect each node to output. These general types are described here.

A node tree showing the main categories of node colors

**Blue MediaIn and Loader Nodes, and Green Generator Nodes**

Blue MediaIn nodes and blue Loader nodes add clips to a composite, and green Generator nodes create images. Both types of nodes output RGBA channels (depending on the source and generator), and may optionally output auxiliary channels for doing advanced compositing operations.

Because these are sources of images, both kinds of nodes can be attached to a wide variety of other nodes for effects creation besides just 2D nodes. For example, you can also connect MediaIn nodes to Image Plane 3D nodes for 3D compositing, or to pEmitter nodes set to “Bitmap” for creating different particle systems. Green Generator nodes can be similarly attached to many different kinds of nodes, for example, attaching a FastNoise node to a Displace 3D node to impose undulating effects to 3D shapes.

Shape nodes are also green, although they must be attached to a specialized set of gray modifier and render nodes (all of which begin with the letter “s” and appear in the Shape category of the Effects Library.)
2D Processing Nodes, Color Coded by Type

These encompass most 2D processing and compositing operations in Fusion, all of which process RGBA channels and pass along auxiliary channels. These include:

– Orange Blur nodes
– Olive Color Adjustment nodes (color adjustment nodes additionally concatenate with one another)
– Pink Paint nodes
– Dark orange Tracking nodes
– Tan Transform node (transform nodes additionally concatenate with one another)
– Teal VR nodes
– Dark brown Warp nodes
– Gray, which includes Compositing nodes as well as many other types.

Additionally, some 2D nodes such as Fog and Depth Blur (in the Deep Pixel category) accept and use auxiliary channels such as Z-Depth to create different perspective effects in 2D.

**TIP:** Two 2D nodes that specifically don’t process alpha channel data are the Color Corrector node and the Gamut node. The Color Correction node lets you color correct a foreground layer to match a background layer without affecting an alpha channel. The Gamut node lets you perform color space conversions to RGB data from one gamut to another without affecting the alpha channel.

Purple Particle System Nodes

These are nodes that connect to create different particle systems, and they’re incompatible with other kinds of nodes until you add a pRender node that outputs 2D RGBA and auxiliary data that can be composited with other 2D nodes and operations.

Dark Blue 3D Nodes

These are 3D operations, which generate and manipulate 3D data (including auxiliary channels) that are incompatible with other kinds of nodes until processed via a Renderer 3D node, which then outputs RGBA and auxiliary data.

Brown Mask Nodes

Masks output single-channel images that can only be connected to one another (to combine masks) or to specified Mask inputs. Masks are useful for defining transparency (Alpha masks), defining which parts of an image should be cropped out (Garbage masks), or defining which parts of an image should be affected by a particular node operation (Effects masks).

Using Channels in a Composition

When you connect one node’s Output to another node’s Input, you feed all of the channels that are output from the upstream node to the downstream node. 2D nodes, which constitute most simple image processing operations in Fusion, propagate all channel data from node to node, including RGB, alpha, and auxiliary channels, regardless of whether or not that node actually uses or affects a particular channel.
2D nodes also typically operate upon all channel data routed through that node. For example, if you connect a node’s output with RGBA and XYZ Normals channels to the input of a Vortex node, all channels are equally transformed by the Size, Center, and Angle parameters of this operation, including the alpha and XYZ normals channels, as seen in the following screenshot.

(Left) The Normal Z channel output by a rendered torus, (Right) The Normal Z channel after the output is connected to a Vortex node; note how this auxiliary channel warps along with the RGB and A channels

This is appropriate because in most cases, you want to make sure that all channels are transformed, warped, or adjusted together. You wouldn’t want to shrink the image without also shrinking the alpha channel along with it, and the same is true for most other operations.

On the other hand, some nodes deliberately ignore specific channels when it makes sense. For example, the Color Corrector and Gamut nodes, both of which are designed to alter RGB data specifically, do not affect auxiliary channels. This makes them convenient for color-matching foreground and background layers you’re compositing, without worrying that you’re altering the depth information accompanying that layer.

**TIP:** If you’re doing something exotic and you actually want to operate on a channel that’s usually unaffected by a particular node, you can always use the Channel Booleans node to reassign the channel. When doing this to a single image, it’s important to connect that image to the background input of the Channel Booleans node, so the alpha and auxiliary channels are properly handled.

**Channel Limiting**

Most nodes have a set of Red, Green, Blue, and Alpha buttons in the Settings tab of that node’s Inspector. These buttons let you exclude any combination of these channels from being affected by that node.

For example, if you wanted to use the Transform node to affect only the green channel of an image, you can turn off the Green, Blue, and Alpha buttons. As a result, the green channel is processed by this operation, and the red, blue, and alpha channels are copied straight from the node’s input to the node’s output, skipping that node’s processing to remain unaffected.
Transforming only the green color channel of the image with a Transform effect

Skipping Channel Processing
Under the hood, most nodes process all channels first, but afterward copy the input image to the output for channels that have been enabled. Modern workstations are so fast that this isn’t usually noticeable, but there are some nodes where deselecting a channel actually causes that node to skip processing that channel entirely. Nodes that operate this way have a linked set of Red, Green, Blue, and Alpha buttons on another tab in the node. In these cases, the Common Control channel buttons are instanced to the channel buttons found elsewhere in the node.

Blur, Brightness/Contrast, Erode/Dilate, and Filter are examples of nodes that all have RGBA buttons in the main Controls tab of the Inspector, in addition to the Settings tab.

Adding Alpha Channels
Much of visual effects compositing has to do with placing a foreground subject over a background. Possibly the most fundamental method is through the use of an alpha or matte channel. If an alpha channel is not contained within the clip, you add one via keying or rotoscoping. While more specific methods are covered in detail in later chapters, here’s an example of how this is handled within Fusion.

In the case of extracting an alpha matte from a green screen image, you typically connect the image’s RGB output to the “Input” input of a Keyer node such as the Delta Keyer, and you then use the keyer’s controls to extract the matte. The Keyer node automatically inserts the alpha channel that’s generated alongside the RGB channels, so the output is automatically RGBA. Then, when you connect the keyer’s output to a Merge node to composite it over another image, the Merge node automatically knows to use the embedded alpha channel coming into the foreground input to create the desired composite, as seen in the following screenshot.

A simple node tree for keying; note that only one connection links the DeltaKeyer to the Merge node

Rotoscoping, or manually drawing a mask shape using a Polygon or other Mask node is another technique used to create the matte channel. There are many ways to configure the node tree for this task, but the simplest setup is just to connect a Polygon or B-Spline mask node to the Effect Mask input of a MediaIn or Loader node.
**TIP:** When rotoscoping, it is best to leave the Mask node disconnected from the image while you draw the shape. This allows you to view the MediaIn node while drawing. Connect the Matte node once you have finished drawing the shape.

In both cases, you can see how the node tree’s ability to carry a single channel or multiple channels of image data over a single connection line simplifies the compositing process.

**How Channels Propagate During Compositing**

Images are combined or composited together using the Merge node. The Merge node takes two RGBA inputs labeled “Foreground” (green) and “Background” (orange) and combines them into a single RGB output (or RGBA if both the foreground and background input images have alpha), where the foreground image is in front (or on top, depending on what you’re working on), and the background image is, you guessed it, in back.

Auxiliary channels, on the other hand, are handled in a much more specific way. When you composite two image layers using the Merge node, auxiliary channels only propagate through the image that’s connected to the background input. The rationale for this is that in most CGI composites, the background is most often the CG layer that contains auxiliary channels, and the foreground is a live-action green screen plate.

Since most compositions use multiple Merge nodes, it pays to be careful about how you connect the background and foreground inputs of each Merge node to make sure that the correct channels flow properly.
**TIP:** Merge nodes are also capable of combining the foreground and background inputs using Z-Depth channels using the “Perform Depth Merge” checkbox, in which case every pair of pixels are compared. Which one is in front depends on its Z-Depth and not the connected input.

### Rearranging or Combining Channels

Last, but certainly not least, it’s also possible to rearrange and re-combine channels in any way you need, using one of four different node operations. For example, you might want to combine the red channel from one image with the blue and green channels of a second image to create a completely different channel mix. Alternatively, you might want to take the alpha channel from one image and merge it with the alpha channel of a second image in different ways, adding, subtracting, or using other intersection operations to create a very specific blend of the two.

The following nodes are used to re-combine channels in different ways:

- **Channel Boolean:** This is a 3D node used to remap and modify channels of 3D materials using a variety of simple pre-defined math operations.

- **Channel Booleans:** Used to shuffle or rearrange RGBA and auxiliary channels within a single input image, or among two input images, to create a single output image. If you only connect a single image to this node, it must be connected to the background input to make sure everything works.

- **Copy Aux:** The Copy Aux node is used to remap channels between RGBA channels and auxiliary data channels in a single 2D image. The Copy Aux node is mostly a convenience node, as the copying can also be accomplished with more effort (and flexibility) using a Channel Booleans node.

- **Matte Control:** Designed to do any combination of the following: (a) re-combining mattes, masks, and alpha channels in various ways, (b) modifying alpha channels using dedicated matte controls, and (c) copying alpha channels into the RGB stream of the image connected to the background input in preparation for compositing. You can copy specific channels from the foreground input to the background input to use as an alpha channel, or you can attach masks to the garbage matte input to use as alpha channels as well.

### Understanding Premultiplication

Now that you understand how to direct and recombine RGB images and alpha channels in Fusion, it’s time to go more deeply into alpha channels to make sure you always combine RGB and alpha channels correctly for each operation you perform in your composite. This might seem simple, but small mistakes are easy to make and can result in unsightly artifacts. This is arguably one of the most confusing areas of visual effects compositing, so don’t skip this section.

When alpha channel and RGB pixels are both contained within a media file, such as a 3D rendered animation that contains RGB and transparency, or a motion graphics movie file with transparency baked in, there are two different ways they might be combined, and it’s important to know which is in use.

- **Unpremultiplied (Straight):** An RGB image unaltered by the semi-transparency information in a fourth channel (alpha channel)

- **Premultiplied:** An RGB image that has each channel multiplied by its alpha channel before compositing.
The term Premultiplied alpha is a term that has historically been used by editors, visual effects artists, and motion graphics designers, but it’s imprecise. The alpha channel itself is not multiplied. The R, G, and B channels are multiplied by the alpha. In the end, the alpha channel stays the same, but the values contained in the R, G, and B channels are modified.

A RGB image (left) and its alpha channel (right)

Non-premultiplied images, sometimes called “straight” alpha channels, have RGB channels that are unaltered (not multiplied) by the alpha channel. The result is that the RGB image has no anti-aliased edges and no semi-transparency. It’s usually obvious where the RGB image ends and the alpha matte begins. The image below is an example of the ragged edges seen in the RGB channels when using a non-premultiplied alpha channel. But notice the smooth semi-transparent edges found in the alpha.

A detailed view of a non-premultiplied RGB image (left) and its alpha channel (right)

A premultiplied alpha channel means the RGB pixels are multiplied by the alpha channel. This method guarantees that the RGB image pixels include semi-transparency where needed, like anti-aliased edges. Most computer-generated images are premultiplied for convenience, because they’re easier to review smoothly without actually being placed inside of a composite.

A detailed view of a premultiplied image (left) and its alpha channel (right)
What does this mean for compositing? The edges of a premultiplied image look much smoother, making them the preferred choice when compositing foreground over the background in a merge. Consequently, all alpha channels are made to be premultiplied in compositing operations if they weren’t already.

On the other hand, it is always preferred to color correct a non-premultiplied RGBA image, because you don’t want to alter the pixel values of an image after the RGB channels have been multiplied by the alpha channel.

If you think of this from a mathematical perspective:

– **RGB pixel value x 0 = 0**: The black transparent areas of an alpha channel have a pixel value of 0. When you take the value of an RGB pixel and multiply it by 0 (n x 0 = 0) then by the laws of multiplication, the RGB value becomes 0, or fully transparent.

– **RGB Pixel value x 1 = RGB Pixel**: The solid or opaque white areas have a value of 1.0. When you take the value of an RGB pixel and multiply it by 1 (n x 1 = n), then the RGB value stays the same, fully opaque.

– **RGB Pixel value x 0.3 = A different color**: Along the edges of an alpha channel are gray pixels, indicating semi-transparency. These semi-transparent pixels have a value falling somewhere between 1.0 and 0.0. To apply the alpha channel’s anti-aliased edges to the RGB channels, you multiply the pixel values. The multiplication process mixes some percentage of the transparent pixels (black) with the RGB pixels. Although this is desired to get good anti-aliased edges, you can not color correct the image because it alters the smooth semi-transparency you created once it is done.

### The Rules of Premultiplication

Following from the information presented above, when you’re compositing multiple images together and one or more has a built-in alpha channel, you want to make sure you follow these general rules to avoid problems:

– Always use premultiplied images with a Merge node.

– Only color-correct images that are not premultiplied.

– Always filter and transform images that are premultiplied.

– Never double premultiply an image.

### Premultiplication and the Merge Node

The foreground input of a Merge node expects a premultiplied RGBA image. It is an additive merge, meaning the semi-transparent areas of the foreground are added over the background. However, if the image is not premultiplied, the pixels that should be transparent are still added, which typically results in an unwanted bright fringe around the edges of your foreground subject.
If you are compositing with a non-premultiplied alpha, you can fix these bright edges by changing the Merge to perform a Subtractive merge in the Inspector.

Nonpremultiplied edges in an additive Merge (left) and premultiplied edges in an additive Merge (right)

**TIP:** When an RGB image and a Mask node are combined using, for instance, a Matte Control node, if the RGB image is not multiplied by the mask in the Matte control, the checkerboard background pattern in the viewer will appear only semi-transparent when it should be fully transparent.

**Color Correcting Premultiplied RGBA Images**

When you premultiply an image, you tie any changes made to the brightness of the RGB pixels to the alpha channel pixels as well. If, for example, you raise the brightness of the foreground image in any way, you’ll also raise the brightness of the alpha channel, which will likely not be desirable as this will change the transparency the alpha channel creates. The visible result of this when viewing the Merge node is that the entire background will become brighter (or darker if you’d lowered the RGB brightness) based on your color adjustment.

For this reason, the rule is always to divide the semi-transparent pixels before performing any color correction on an image with an alpha channel. You can do this turning on the Pre-Divide/Post Multiply checkbox in any node that performs color correction. Alternatively, you can use the Alpha Divide and Alpha Multiply nodes to do the same thing. These methods are covered in more detail later in this chapter.

Color correcting a premultiplied foreground incorrectly alters the background (left). Color correcting a nonpremultiplied foreground works correctly (right).
Double Premultiplied RGBA Means Double Trouble

A common mistake made by many artists is to over-compensate for premultiplication. As important as it is to premultiply the alpha before compositing in a Merge node, it’s just as important not to double premultiply the alpha. Performing a premultiply operation two times in a row can create a darken halo effect around your images. You are effectively multiplying by the gray semi-transparent pixels twice; this is not optimal.

Premultiplied Alpha Channels and Filtering

When dealing with filtering, the state of the RGBA channels shouldn’t matter for most composites. However, an exception might be if the filter algorithm you choose includes color modification. For instance, if a filter attempts to simulate a defocus by blooming highlights like a real light source, that filter might over-brighten pixels near a transparent edge, which will result in some manner of artifact when that image is composited.

Alpha Channel Status in MediaIn and Loader Nodes

When using a Loader node to add a clip to the composite, the Import tab in the Inspector includes a group of checkboxes that let you determine how an embedded alpha channel is handled. There are checkboxes to make the alpha channel solid (ignore transparency), to Invert the alpha channel, and to Post-Multiply the RGB channels with the alpha channel, should that be necessary.

When using a MediaIn node, you can modify how an embedded alpha channel is interpreted using the Clip attributes window. The Clips Attributes window includes an Alpha Mode menu setting to choose if the alpha channel is ignored, treated as premultiplied, inverted, or treated as nonpremultiplied (straight).

Controlling Premultiplication in Color Correction Nodes

Most nodes that require you to explicitly deal with the state of premultiplication of an RGBA image have a “Pre-Divide, Post-Multiply” checkbox. This includes simple color correction nodes such as Brightness Contrast and Color Curves, as well as the Color Correct node, which has the “Pre-Divide/Post-Multiply” checkbox in the Options panel of its inspector settings.
This checkbox allows you to connect an RGBA premultiplied image to the node and perform a color correction operation. It takes the RGBA image input, performs a divide operation to remove the semi-transparency and then performs a multiplication operation before outputting the color corrected image. This way, the color correction is done using a nonpremultiplied image but the resulting output is a Merge-friendly premultiplied image.

**Controlling Premultiplication With Alpha Divide and Alpha Multiply**

The Alpha Divide and Alpha Multiply nodes, found in the Matte category of the Effects Library, are available when multiple operations in a row expect a “straight” alpha channel. Instead of performing repetitive Pre-Divide/Post Multiply operations on each node, you can use these two nodes to book-end the other nodes. Simply add the Alpha Divide node when you want the RGBA image data not to be premultiplied, and add the Alpha Multiply node when you want the image data to be premultiplied again. For example, if you’re using third-party OFX nodes that make color adjustments, you may need to control premultiplication before and after such an adjustment manually.

![Node tree with explicit Alpha Divide and Alpha Multiply nodes](image)

**Multi Channel Compositing**

If you’ve gone to the cinema and seen any recent superhero movie, you will have seen the results of sophisticated 3D rendering, combined with a whole lot of compositing. 3D applications can render very realistic images but the time it takes to render each frame of those realistic images can be measured in hours, not minutes. Any change to the 3D images, even relatively simple operations like color adjustments, changes to focus, filtering, or additional masking, means these images will need to be re-rendered entirely, which means you waiting, often many times over. For efficiencies sake, it’s much faster to make iterative changes that can be accomplished with 2D image processing operations in Fusion instead.

To have the flexibility you need to make common changes to 3D images after-the-fact, the various attributes that make up the 3D scene are separated and rendered as different image sequences, often referred to as render passes. For example, render passes are often created for attributes like raw color, shadows, and reflections, that can be recombined as a 2D composite to produce the final result. Having different attributes rendered into different image sequences gives you a significant amount of flexibility, since now each image attribute can be color corrected, blurred, or further processed independently of the other attributes of the image, with fast-processing operations in Fusion.
The most common render passes that are typically generated come from the RGBA channels of the 3D scene. These are collectively called beauty passes and can consist of attributes like color, shadows, lighting, reflections, environment, and others.

Render passes can also contain non-RGB data. Different effects applications have different names for these passes, such as Data Channels, or AOVs (Arbitrary Output Variables). In Fusion, these channels are called Auxiliary Channels, and they contain 3D data such as Depth, Normals, Motion Vectors, and UV Coordinates (to name just a few).

When compositing a 3D render consisting of multiple render passes, the beauty passes are handled using one technique, and the Auxiliary Channels are handled with another. Since Fusion nodes carry RGBA channels by default, we’ll cover beauty passes first, and then explain how to work with Auxiliary Channels later in this chapter.

**Compositing with Beauty Passes**

Each attribute of a beauty pass can be rendered into individual image sequences, so you end up with a series of numbered images, one for the diffuse pass, one for the reflection pass, another of the shadow pass, and so on. Alternatively, all the passes can be contained in a multi-part EXR image sequence. Multi-part EXRs benefit from requiring a bit less file management, but the passes are handled similarly in Fusion using either method.

A single MediaIn or Loader node only handles a single beauty pass since only one set of RGBA channels gets output per node. Setting up your composite in Fusion requires you to use a separate MediaIn or Loader node for each pass.

A MediaIn or Loader node is needed for each beauty pass.

**TIP:** The EXR format in Fusion is optimized when multiple Loaders are used to read the same EXR file. The file is only loaded once to access all the channels.

**Beauty Pass Setup**

Separated components of 3D renders, such as diffusion, shadows, or reflections, can be rendered individually using RGB channels. If you’re provided with individual image sequences for each image component, they’ll import and open in Fusion and can be displayed in the viewer, just like any other clip. If you’re using multi-part EXR files, then you essentially have multiple RGB images contained within a single file. However, the MediaIn and Loader nodes can only make use of one set of RGB channels at a time. If you want to composite multiple RGB beauty passes together with one another, you must use multiple MediaIn or Loader nodes that point to the same image sequence but are assigned to different passes contained in the EXR file.
Multiple Loader or MediaIn nodes connect to a multi-part EXR image sequence

**TIP:** It is wise to rename each Loader or MediaIn to represent the beauty pass it contains.

**Mapping Each Set of Beauty Passes to a Particular Node**

Depending on whether you’re using a MediaIn node or a Loader node, beauty passes can be mapped to RGB channels using either the Image tab, the Channels tab, or the Format tab in the Inspector. When using a Loader node, the Loader’s Format tab is used.

![Beauty passes mapped to red, green, and blue channels in a Loader node](image)

The MediaIn’s Image tab includes a Layer menu. Any pass included in a multi-part EXR image sequence can be selected from this menu and automatically assigned to the RGBA channels.
The Layer menu in a MediaIn node showing headings for combined channel passes.

In most cases, the menu shows the combined channel passes, meaning the individual red, green, blue, and alpha channels cannot be selected. Because the alpha channel is not included in many beauty passes, you sometimes need to borrow the alpha channel from a different beauty pass. For this reason, it’s often better to use the Channels tab for mapping the individual channels of a beauty pass to the channels of the MediaIn node.

The MediaIn node’s Channels tab or the Loader’s Format tab provides access to individual channels.

The MediaIn node in DaVinci Resolve and the Format tab in a Loader node include the same channel mapping functionality. The Channels tab and the Format tab include individual RGBA menus at the top of the tab. You can use these menus to map the RGBA channels from any pass contained in the multi-part EXR. For instance, if you want to map the Ambient Occlusion pass to the RGB channels, choose AO. R (Red) from the Red channel menu, AO. G (Green) from the Green channel menu, and AO. B (Blue) from the Blue channel menu.

A pass’ individual channels mapped to the red, green, blue, and alpha channels in the MediaIn node.
TIP: Different 3D applications will label beauty passes in different ways. For instance, the name for an Ambient Occlusion beauty pass may be AO, AM OCC, or some other abbreviation.

The Ambient Occlusion beauty pass does not include an alpha channel. To composite it, you can reuse the alpha channel pass from another beauty pass. In the image below, the alpha channel is mapped using the combined render pass’ alpha channel.

TIP: When using the Format tab in the Loader node, the checkbox next to each channel needs to be turned on for the corresponding channel to become available in the node’s output.

Compositing Multiple Beauty Passes in the Node Editor

Once all of your passes are brought in and mapped to RGBA channels, you’ll end up with a series of MediaIn or Loader nodes. How many MediaIn and Loader nodes is really up to your workflow. There is no predefined number of passes you will use. Every studio decides for themselves the standard set. However, there are common render passes that are involved in most composites. The following is a list of commonly used render passes and their generic names.
Compositing multiple beauty passes into a single output image is relatively straightforward. 3D rendering applications typically output linear gamma, so no Gamut or other color space conversion nodes are required if you're keeping the image in a linear color space for ease of compositing.

The basic compositing is accomplished with either a Merge node or a Channels Booleans node. Both allow for additive combining of render passes. There's no strict requirement for compositing each pass in any particular way, although in most situations a simple additive composite should work just fine.

**To begin compositing render passes using a Merge node:**

1. Connect a Color pass to the background input of a Merge node.
2. Connect a Direct Lighting pass to the foreground input.
3. Adjust the Alpha gain and Blend parameters to get the look you desire.

![Compositing beauty passes starts by connecting a background and foreground into a Merge node](image)

If you prefer, you can use a Channels Booleans node to make the same composite. In this case, there is no technical difference between the two nodes.

**To composite render passes with a Channels Booleans node:**

1. Connect a Color pass to the background input of a Channels Booleans node.
2. Connect a Direct Light pass to the foreground input.
3. Choose Add from the Operations menu.
4. Choose Do Nothing from the Alpha To menu.

![Channel Booleans is set to Add to combine the foreground input and the background input.](image)

One of the exceptions to the steps above are Shadow passes, such as Ambient Occlusion. In that case, a multiply Apply mode is usually employed.

**To composite an Ambient Occlusion render pass using a Merge node:**

1. Connect last of a sequence of Merge node render passes to the background input of a Merge node.
2. Connect an Ambient Occlusion pass to the foreground input.
3. Choose Multiply from the Apply Mode menu.
4. Adjust the Gain and Blend parameters to get the look you desire.
As straightforward as this sounds, compositing using a recipe doesn’t always work for every shot. When using different images, you may need to experiment with varying techniques of compositing for the best results.

**Embedding Alpha into Beauty Passes**

Alpha channels are not included in all beauty passes. If your shot requires that you composite your assembled beauty passes over live-action or some other background, it may be up to you to add the alpha channel from a pass that does include it.

**To add an alpha channel into your assembled beauty pass composite, do the following:**

1. Connect the last Merge or Channel Booleans output into the background input of a Matte Control node.
2. Connect the render pass that contains the alpha into the green Foreground input of the Matte Control node.
3. In the Matte Control’s Inspector, choose Combine Alpha from the Combine menu.
4. Choose Copy from the Combine Op menu.

**TIP:** Alpha channels from 3D renderings are typically premultiplied. That being the case, be sure to turn on the Pre Divide/Post Multiply checkbox on any node that performs color correction. If using more than one node in a row to perform color correction, use the Alpha Divide and Alpha Mult nodes instead.

**Working with Auxiliary Channels**

Auxiliary channels are not RGB images; they are a family of special-purpose 3D image data that typically describes position, orientation, and object information for use in 2D composites. For example, Z-Depth channels describe the depth of each pixel of an image along a Z-axis, while an XYZ Normals channel describes the orientation (facing up, facing down, facing to the left or right) of every pixel in an image.

Similar to the use of multiple beauty passes, one of the most common reasons to use auxiliary data is to eliminate the need to re-render computationally expensive 3D imagery, by enabling even more aspects of rendered images to be manipulated after-the-fact. 3D rendering is computationally expensive and time-consuming, so outputting descriptive information about a 3D image allows sophisticated alterations to occur in 2D compositing, which is faster to perform and adjust.

There are two ways of obtaining auxiliary channel data:

- First, auxiliary data may be embedded within a clip rendered from a 3D application, most often using the EXR file format. In this case, it’s best to consult your 3D application’s documentation to determine which auxiliary channels can be generated and output.
– You may also obtain auxiliary channel data by generating it within Fusion, via 3D operations output by the Renderer 3D node, by the Optical Flow node, or by the Disparity node.

An RGBA 3D rendered scene that also contains auxiliary channels

**TIP:** When trying to locate information about auxiliary channels in other software, some 3D applications refer to auxiliary channels as Arbitrary Output Variables (AOVs), render elements, or secondaries.

**Aux Channel Setup**

When using a MediaIn or Loader node that links to a multi-part EXR file with auxiliary channel data, the Inspector’s Channels or Format tab includes a pre-defined set of auxiliary channels for mapping purposes. Each pre-defined channel includes a menu that displays every attribute included in a multi-part EXR. From the menu, you select the render pass that should be assigned to the corresponding channel. As described earlier, RGB beauty passes like diffuse, shadow, and reflection are mapped to the red, green, and blue channels. Auxiliary passes include preset mappings.

A multi-part EXR file with embedded render passes mapped to their aux channels in a MediaIn node
Displaying Channels in the Viewer

Once you map an auxiliary channel in the Inspector, you can display the data as an RGB image in the viewer. Clicking the drop down Color menu at the top of the viewer reveals a list of every active auxiliary channel for the currently viewed node.

![Image of viewer with auxiliary channels]

Select an aux channel from the color drop-down menu to display the aux channel in the viewer.

**TIP:** The Color Inspector SubView can be used to read numerical values from all of the channels.

Auxiliary Channels Explained

Fusion is capable of using auxiliary channels to perform depth-based compositing, to create masks and mattes based on Object or Material IDs, and for texture replacements. Nodes that work with auxiliary channel information have been specifically developed to work with this data. The auxiliary channels that are supported in Fusion are described below.

**Z-Depth**

Each pixel in a Z-Depth channel contains a value that represents the relative depth of that pixel in the scene. In the case of overlapping objects in a model, most 3D applications take the depth value from the object closest to the camera when two objects are present within the same pixel since the closest object typically obscures the farther object.

When present, Z-Depth can be used to perform depth merging using the Merge node or to control simulated depth-of-field blurring using the Depth Blur node.
For this example, we’ll examine the case where the Z-Depth channel is provided as a separate file. The Z- channel can often be rendered as an RGB image. You’ll need to combine the beauty and Z pass using a Channel Booleans node. When the Z pass is rendered as an image in the RGB channels, the Channels Booleans node is used to re-shuffle the Lightness of the foreground RGB channel into the Z-channel.

To combine the Z-pass and beauty pass:

1. Connect the MediaIn node containing the the beauty pass to the background input of the Channel Booleans node.
2. Connect the MediaIn node containing the Z-Depth pass to the green foreground input of the Channel Booleans node.
3. Select the Channel Booleans node, and use the Inspector to set the To Red, To Green, To Blue, and To Alpha menus to Do Nothing.
4. Select the Aux tab, and set the To Z Buffer menu to Lightness FG.
5. Connect the output of the Channels Booleans node into the Depth Blur node.

The Depth Blur node is one of the nodes that take advantage of a Z-channel in order to create blurry depth-of-field simulations. To set this up, the output of the MediaIn node connects to the background input on the Depth Blur.
The Depth Blur’s controls in the Inspector are very dependent on the type of image you’re using. It can be easier to begin by adjusting the controls in the Inspector to some better defaults. Start by increasing the Blur Size to 10. This will make it easier to see even the smallest of changes. Next, instead of using the Focal Point, you should pick a focal point in the image by dragging the Sample button into the viewer and selecting a pixel that determines the part of the picture to keep in focus.

The final setup steps are to lower Z Scale to somewhere around 0.2 (if you’re using a floating-point image), and leave the Depth of Field alone for now. This should show you some blurring in the image.

Start by improving the defaults if your image is 16- or 32-bit floating point.

Once you see these experimental results, you can return to each parameter and refine it as needed to achieve the actual look you want.

TIP: Z-Depth channels often contain negative values. If this causes problems, you can choose Normalize Color Range from the viewer’s Options menu to apply a normalization to the viewer, keeping the image within a range from 0 to 1.
Z-Coverage

The Z-Coverage channel is a somewhat extinct render pass in most 3D applications. It was a way of restoring antialiasing to rendered color masks and Z-Depth passes. It indicated pixels in the Z-Depth that contained two objects. The value was used to indicate, as a percentage, how transparent that pixel was in the final depth composite. It can still be used today if you are rendering files from one of the few applications that can produce them.

TIP: The wide adoption of an open-source matte creation technology called Cryptomatte, has somewhat superseded mattes created from Coverage, Background, Object ID, and Material ID passes.

Background RGBA

This channel is a somewhat extinct render pass in most 3D applications. It contained the color values from the objects behind the pixels described in the Z coverage.

Object ID

Most 3D applications are capable of assigning ID values to objects in a scene. Each pixel in the Object ID channel will be identified by that ID number, allowing for the creation of masks.

If you want to use an Object ID in a comp, like all aux channels you must map the Object ID pass to the Object ID channel in the MediaIn or Loader Node.

To use an ObjectID pass, do the following:

1. In the MediaIn or Loader node, use the Channels or Format tab to map the Object ID pass to the Object ID aux channel.

2. In whatever node you want to have affected by the ObjectID matte, select the Settings tab, turn on the Object ID checkbox, and select the ID number assigned to the object.

Material ID

Most 3D applications are capable of assigning ID values to materials in a scene. Each pixel in the Material ID channel will be identified by that ID number, allowing for masks based on materials.

You can set up Material IDs using the Settings tab, similarly to how ObjectIDs are set.
UV Texture

The UV Texture channels contain information about how pixels in an image map to texture coordinates. This is used to retexture an object in a 2D image. For instance, if you want to apply a logo onto a rendered object, you can use the UV aux channel with the Texture node.

Texture (left) applied to 2D image (right) using UV channels and texture node.

To use a UV pass, do the following:

1. In the MediaIn or Loader node, use the Channels or Format tab to map the U and V pass to the U and V aux channels.
2. Connect the output of the MediaIn or Loader node to the background input of the Texture node.
3. Connect the texture image you want to use to the foreground input of the Texture node.
4. If you want to combine the original texture with the new texture, use a merge with the background input from the original image and the foreground input from the Texture node.
5. Adjust Merge’s Apply mode, Alpha Gain, and blend to get the desired mix of the two textures.

UV channels from a MediaIn node used in a Texture node and merged over the original image

Tip: If you are using a separate UV render pass with the UV data in the RGB channels, map red to U and green to V in a Channel Booleans node.

X, Y, and Z Normals

The X, Y, and Z Normal channels contain information about each pixel’s orientation (the direction it faces) in 3D space. The normals are often displayed as lines coming out from your object perpendicular to the surface, letting you visualize the relationship between the surface and camera.
The Normals display the direction of the surface.

The Normals X, Y, and Z channels are often used with a Shader node to perform relighting adjustments on a 2D rendered image.

To setup a Shader node to use XYZ Normals, do the following:

1. In the MediaIn or Loader node, use the Channels or Format tab to map the individual X, Y, and Z Normals pass to the X Normal, Y Normal, and Z Normal channels.
2. Connect the output of the MediaIn or Loader node to the background input of the Shader node.
3. Optionally, connect a floating-point EXR image to be used as a reflection image to the Shader node's reflection input.
4. Adjust the Shader controls to perform relighting.

XY Vector and XY BackVector

The Vector channels indicates the pixel's motion from frame to frame. It can be used to apply motion blur to an image or to generate optical flow analysis for retiming. The XY Vector points to the next frame, while the XY BackVector points to the previous frame.
Often the vector pass will be rendered in a separate pass as an RGB image. The X and Y vector data is located in the R and G channels. In order to place them in the vector channels, you can use a Channel Booleans node.

To use a Motion Vector pass to create motion blur, do the following:

1. Add a MediaIn or Loader node for the image and the Vector render pass.
2. Connect the output of the image into the background of a Channel Booleans node.
3. Connect the output of the Vector render pass to the Channel Boolean’s foreground.
4. In the Channel Booleans inspector, set the To Red, To Green, To Blue, and To Alpha all to Do Nothing.
5. Select to the Aux tab.
6. Turn on Enable Extra Channels.
7. Set the To X Vector drop-down menu to Red FG, and then set the To Y Vector drop-down menu to Green FG.
8. Connect the Channel Booleans node’s output to the yellow background input on a Vector Motion Blur node.

The Vector render pass is combined with the beauty image using the Channels Booleans node, which then feeds the Vector Motion Blur node.

World Position

World Position Pass (WPP) is an auxiliary channel, sometimes referred to as Point Position, XYZ pass, or WPP. It's used to represent each pixel’s 3D (XYZ) position as an RGB color value. The result is data that can be viewed as a very colorful RGB image. Like Z-Depth, this can be used for compositing via depth. However, it can also be used for masking based on 3D position, regardless of camera transforms.

The colors correspond to a pixel’s position in 3D, so if a pixel sits at 0/0/0 in a 3D scene, the resulting pixel’s will have an RGB value of 0/0/0 or black. If a pixel sits at 1/0/0 in the 3D scene, the resulting pixel is fully red. Due to the huge extent, 3D scenes can have the WPP channel should always be rendered in 32-bit floating-point to provide the accuracy needed.
XY Disparity

XY Disparity is the only channel listed here that is not generated in a 3D application. These channels indicate where each pixel's corresponding matte can be found in a stereo image. Each eye, left and right, will use this vector to point to where that pixel would be in the other eye. This can be used for adjusting stereo effects, or to mask pixels in stereo space.

![Combined X and Y Disparity channels](image)

Using Cryptomatte in Fusion

Cryptomatte is an open-source technology that has been widely adopted in 3D applications. Unlike Z-Depth mattes or Object IDs, Cryptomatte automatically generates anti-aliased ID mattes from 3D renders with support for motion blur, transparency, and depth of field.

Fusion does not natively support the Cryptomatte format. However, using a free plug-in from 3rd party developers, you can use Cryptomatte render passes in Fusion.

Cryptomatte for Fusion can be downloaded and installed for free: https://github.com/Psyop/Cryptomatte

Or to use an easier installer, you can download Reactor, which comes bundled with Cryptomatte and offers many other free, useful Fusion plug-ins. Reactor can be found at: https://www.steakunderwater.com

Propagating Auxiliary Channels

Ordinarily, auxiliary channels are propagated along with RGBA image data, from node to node, among gray-colored nodes, including those in the Blur, Filter, Effect, Transform, and Warp categories. Basically, most nodes that simply manipulate channel data propagate (and potentially manipulate) auxiliary channels with no problems.

However, when you composite two image layers using the Merge node, auxiliary channels only propagate through the image that’s connected to the background input. The rationale for this is that in most composites that include computer-generated imagery, the background is most often the CG layer that contains auxiliary channels, while the foreground is a live-action green screen plate with subjects or elements that are combined against the background, which lack auxiliary channels.
Nodes That Use Auxiliary Channels

The availability of auxiliary channels opens up a world of advanced compositing functionality. This section describes every Fusion node that has been designed to work with images that contain auxiliary channels.

- **Copy Aux**: The Copy Aux tool can copy auxiliary channels to RGB and then copy them back. It includes some useful options for remapping values and color depths, as well as removing auxiliary channels.

- **Channel Booleans**: The Channel Boolean tool can be used to combine or copy the values from one channel to another in a variety of ways.

- **Custom Tool, Custom Vertex 3D, pCustom**: The “Custom” tools can sample data from the auxiliary channels per pixel, vertex, or particle and use that for whatever processing you would like.

- **Depth Blur**: The Depth Blur tool is used to blur an image based on the information present in the Z-Depth. A focal point is selected from the Z-Depth values of the image and the extent of the focused region is selected using the Depth of Field control. The Scale value default is based on an 8-bit image so it is important to lower the scale value when using the Depth Blur with 16- or 32-bit float files.

- **Disparity to Z, Z to Disparity, Z to WorldPos**: These tools use the inherent relationships between depth, position, and disparity to convert from one channel to another.

- **Fog**: The Fog tool makes use of the Z-Depth to create a fog effect that is thin closer to the camera and thickens in regions farther away from the camera. You use the Pick tool to select the Depth values from the image and to define the Near and Far planes of the fog’s effect.

- **Lumakeyer**: The Lumakeyer tool can be used to perform a key on the Z-Depth channel by selecting the Z-Depth in the channel drop-down list.

- **Merge**: In addition to regular compositing operations, Merge is capable of merging two or more images together using the Z-Depth, Z-Coverage, and BG RGBA buffer data. This is accomplished by enabling the Perform Depth Merge checkbox from the Channels tab.

- **New Eye**: For stereoscopic footage, New Eye uses the Disparity channels to create new viewpoints or to transfer RGBA data from one eye to the other.

- **Shader**: The Shader tool applies data from the RGBA, UV and the Normal channels to modify the lighting applied to objects in the image. Control is provided over specular highlights, ambient and diffuse lighting, and position of the light source. A second image can be applied as a reflection or refraction map.

- **Shadow**: The Shadow tool can use the Z-Depth channel for a Z-Map. This allows the shadow to fall onto the shape of the objects in the image.

- **Smooth Motion**: Smooth Motion uses Vector and Back Vector channels to blend other channels temporally. This can remove high frequency jitter from problematic channels such as Disparity.

- **SSAO**: SSAO is short for Screen Space Ambient Occlusion. Ambient Occlusion is the lighting caused when a scene is surrounded by a uniform diffuse spherical light source. In the real world, light lands on surfaces from all directions, not from just a few directional lights. Ambient Occlusion captures this low frequency lighting, but it does not capture sharp shadows or specular lighting. For this reason, Ambient Occlusion is usually combined with Specular lighting to create a full lighting solution. The SSAO tool uses the Z-Depth channel but requires a Camera3D input.

- **Stereo Align**: For stereoscopic footage, the Disparity channels can be used by Stereo Align to warp one or both of the eyes to correct misalignment or to change the convergence plane.

- **Texture**: The Texture tool uses the UV channels to apply an image from the second input as a texture. This can replace textures on a specific object when used in conjunction with the Object ID or Material ID masks.
– **Time Speed and Time Stretcher**: These tools can use the Vector and BackVector channels to retime footage.

– **Vector Distortion**: The forward XY Vector channels can be used to warp an image with this tool.

– **Vector Motion Blur**: Using the forward XY Vector channels, the Vector Motion Blur tool can apply blur in the direction of the velocity, creating a motion blur effect.

– **Volume Fog**: Volume Fog is a raymarcher that uses the World Position channels to determine ray termination and volume dataset placement. It can also use cameras and lights from a 3D scene to set the correct ray start point and Illumination parameters.

– **Volume Mask**: Volume Mask uses the World Position channels to set a mask in 3D space as opposed to screen space. This allows a mask to maintain perfect tracking through a camera move.

**TIP**: The Object ID and Material ID auxiliary channels can be used by some tools in Fusion to generate a mask. The “Use Object” and “Use Material” settings used to accomplish this are found in the Settings tab of that node’s controls in the Inspector.

### Image Formats That Support Aux Channels

Fusion supports auxiliary channel information contained in a variety of image formats. The number of channels and methods used are different for each format.

– **OpenEXR (*.exr)**: The OpenEXR file format is the primary format used to contain an arbitrary number of additional image channels. Many renderers that will write to the OpenEXR format will allow the creation of channels that contain entirely arbitrary data. For example, a channel with specular highlights might exist in an OpenEXR. In most cases, the channel will have a custom name that can be used to map the extra channel to one of the channels recognized by Fusion.

– **SoftImage PIC (*.PIC, *.ZPIC and *.Z)**: The PIC image format (used by SoftImage) is an older image format that can contain Z-Depth data in a separate file marked by the ZPIC file extension. These files must be located in the same directory as the RGBA PIC files and must use the same names. Fusion will automatically detect the presence of the additional information and load the ZPIC images along with the PIC images.

– **Wavefront RLA (*.RLA), 3ds Max RLA (*.RLA) and RPF (*.RPF)**: This is an older image format capable of containing any of the image channels mentioned above. All channels are contained within one file, including RGBA, as well as the auxiliary channels. These files are identified by the RLA or RPF file extension. Not all RLA or RPF files contain auxiliary channel information, but most do. RPF files have the additional capability of storing multiple samples per pixel, allowing different layers of the image to be loaded for very complex depth composites.

– **Fusion RAW (*.RAW)**: Fusion’s native RAW format is able to contain all of the auxiliary channels as well as other metadata used within Fusion.

### Creating Auxiliary Channels in Fusion

The following nodes create auxiliary channels:

– **Renderer 3D**: Creates these channels in the same way as any other 3D application would, and you have the option of outputting every one of the auxiliary data channels that the Fusion page supports.

– **Optical Flow**: Generates Vector and Back Vector channels by analyzing pixels over consecutive frames to determine likely movements of features in the image.

– **Disparity**: Generates Disparity channels by comparing stereoscopic image pairs.
Chapter 80

Compositing Layers in Fusion

This chapter is intended to give you a solid base for making the transition from a layer-based compositing application to Fusion’s node-based interface. It provides practical information about how to start structuring a node tree for simple layered composites.

Contents

Applying Effects 1419
Adding a Node to the Tree 1419
Editing Parameters in the Inspector 1419
Replacing Nodes 1420
Adjusting Fusion Sliders 1421
Compositing Two Clips Together 1421
Adding Additional Media to Compositions 1421
Automatically Creating Merge Nodes 1422
Fixing Problem Edges in a Composite 1423
Using Composite Modes in the Merge Node 1424
Creating and Using Text 1425
Creating Text Using the Text+ Node 1425
Styling and Adjusting Text 1426
Using Text as a Mask 1427
Using Transform Controls in the Merge Node 1430
Building a Simple Green-Screen Composite 1431
Mapping Timeline Layers to Nodes in Fusion 1431
Pulling a Green-Screen Key Using the Delta Keyer 1433
Dealing with Spill 1436
Masking a Graphic 1437
Applying Effects

Before we dive into multi-layered composites, let’s start by looking at some very simple effects and build up from there. Opening the Effects Library, then clicking the disclosure control to the left of Tools, reveals a list of categories containing all the nodes available in Fusion. As mentioned before, each node does one thing, and by using these nodes in concert you can create extremely complex results from humble beginnings.

Clicking the Effect category reveals its contents. In this example we’ll use the TV effect.

Adding a Node to the Tree

Assuming that the MediaIn node in the Fusion page or the Loader node in Fusion Studio is the currently selected node in the Node Editor, clicking once on the TV node, for example, in the Effects Library automatically adds that node to the node tree to the right of the selected node. In the Fusion page, it immediately takes effect in the viewer thanks to the fact that the MediaOut1 node is what’s loaded in the viewer, since that means that all nodes upstream of the MediaOut1 node will be processed and shown.

In Fusion Studio, you must press the 1 or 2 key on the keyboard to load the selected node in the viewer.

There are many other ways of adding nodes to your node tree, but it’s good to know how to browse the Effects Library as you get started.

Editing Parameters in the Inspector

To improve an effect, you can make an adjustment to a node’s parameters in the Inspector at the right. The selected node shows its controls in the Inspector, in which most nodes have several tabs of controls seen as little icons just underneath that node’s title bar.
Clicking the last panel on any node opens the Settings panel. Every node has a Settings panel, and this is where the parameters that every node shares, such as the Blend slider and RGBA buttons, are found. These let you choose which image channels are affected, and let you blend between the effect and the original image.

In the case of the TV effect, for example, the resulting image has a lot of transparency because the scan lines being added are also being added to the alpha channel, creating alternating lines of transparency. Turning off the Alpha checkbox results in a more solid image, while opening the Controls tab (the first tab) and dragging the Scan Lines slider to the right to raise its value to 4 creates a more visible television effect.

**Replacing Nodes**

In the Effect category of the Effects Library, you’ll also find a Highlight node that adds glints to the highlights of an image.
Instead of clicking the Highlight node, which would add it after the currently selected node, dragging and dropping a node from the Effects Library on top of a node in the Node Editor replaces the node in the Node Editor.

![Dragging a node from the Effects Library onto a node in the Node Editor to replace it](image)

In our example, the Highlight node takes the TV node’s place in the node tree, and the new effect can be seen in the viewer, which in this example consists of star highlights over the lights in the image.

It’s time to use the Inspector controls to customize this effect.

### Adjusting Fusion Sliders

When you drag a slider in the Fusion Inspector—in this case, the Number of Points slider—a little dot appears underneath it. This dot indicates the position of the default value for that slider and also serves as a reset button if you click it.

![Adjusting a slider reveals a reset button underneath it](image)

Each slider is limited to a different range of minimum and maximum values that is particular to the parameter you’re adjusting. In this case, the Number of Points slider maxes out at 24. However, you can remap the range of many (but not all) sliders by entering a larger value in the number field to the right of that slider. Doing so immediately repositions the slider’s controls to the left as the slider’s range increases to accommodate the value you just entered.

![Entering a larger value to expand the range over which a slider will operate](image)

### Compositing Two Clips Together

As entertaining as it is adding individual nodes to create simple effects, eventually you’ll need to start adding additional layers of media in order to merge them together as composites. Let’s turn our attention to another example in which we need to combine a background clip with a foreground clip that includes a built-in alpha channel, to see simple layering in action.

### Adding Additional Media to Compositions

You’ll often find that even though you start out wanting to do something relatively simple, you end up adding additional media to create the effect that you need.
In Fusion Studio, you do this by adding additional Loader nodes. If you add a new Loader node to an empty area of the Node Editor, you’ll add an unconnected Loader2 node (incremented to keep it unique) that you can then connect how you want.

In the Fusion page, you can open the Media Pool and drag clips directly to the Node Editor to add them to your node tree. If you drag a clip from the Media Pool to an empty area of the Node Editor, you’ll add an unconnected MediaIn2 node (incremented to keep it unique) that you can then connect in any way you want.

Automatically Creating Merge Nodes

If you want to connect the incoming clip immediately to your node tree as the top layer, or foreground, of a composite, in Fusion Studio select the Loader1 node and then add a second Loader node. In the Fusion page, drag the new clip from the Media Pool right on top of any connection line.

In both cases, the new MediaIn or Loader node automatically becomes the “foreground input”.

The Node Editor is filled with shortcuts like this to help you build your compositions more quickly. Here’s one for when you have a disconnected node that you want to composite against another node with a Merge node. Drag a connection from the output of the node you want to be the foreground layer, and drop it on top of the output of the node you want to be the background layer. A Merge node will be automatically created to build that composite. Remember: background inputs are orange, and foreground inputs are green.
Adding Clips to a Fusion Composition From the File System

If you drag clips from the file system directly into the Node Editor, they’ll be added to the DaVinci Resolve Media Pool automatically. So, if you have a library of stock animated background textures and you’ve just found one you want to use using your file system’s search tools, you can simply drag it straight into the Node Editor and it’ll be added to the currently selected bin of the Media Pool.

Fixing Problem Edges in a Composite

Most often, the Merge node does a perfectly good job when handed a foreground image with premultiplied alpha transparency to composite against a solid background image. However, from time to time, you may notice a small bit of fringing at the edge of the border of a foreground element and transparent area, such as seen in the following close-up. This slight lightening at the edge is a tell-tale sign that the clip probably wasn’t premultiplied. The Merge node expects all foreground images with alpha channels to be premultiplied. But this is something that’s easily fixed.

A bit of fringing at the edge of a foreground element surrounded by transparency

Click to select the Merge node for that particular composite, and look for the Subtractive/Additive slider.

The Subtractive/Additive slider, which can be used to fix or improve fringing in composites

Drag the slider all the way to the left, to the Subtractive position, and the fringing disappears.

A clip with alpha exhibits fringing (left), and after fixing fringing by dragging the Subtractive/Additive slider to the left (right)
The Subtractive/Additive slider, which is only available when the Apply mode is set to Normal, controls whether the Normal mode performs an Additive merge, a Subtractive merge, or a blend of both. This slider defaults to Additive merging, which assumes that all input images with alpha transparency are premultiplied (which is usually the case). If you don’t understand the difference between Additive and Subtractive merging, here’s a quick explanation:

– An Additive merge, with the slider all the way to the right, is necessary when the foreground image is premultiplied, meaning that the pixels in the color channels have been multiplied by the pixels in the alpha channel. The result is that transparent pixels are always black, since any number multiplied by 0 is always 0. This obscures the background (by multiplying with the inverse of the foreground alpha), and then simply adds the pixels from the foreground.

– A Subtractive merge, with the slider all the way to the left, is necessary if the foreground image is not premultiplied. The compositing method is similar to an Additive merge, but the foreground image is first multiplied by its own alpha to eliminate any background pixels outside the alpha area.

The Additive/Subtractive slider lets you blend between two versions of the merge operation, one Additive and the other Subtractive, to find the best combination for the needs of your particular composite. Blending between the two is occasionally useful for dealing with problem composites that have edges that are calling attention to themselves as either too bright or too dark.

For example, using Subtractive merging on a premultiplied image may result in darker edges, whereas using Additive merging with a non-premultiplied image will cause any non-black area outside the foreground’s alpha to be added to the result, thereby lightening the edges. By blending between Additive and Subtractive, you can tweak the edge brightness to be just right for your situation.

### Using Composite Modes in the Merge Node

To create a more convincing composite in layer-based systems, you often use Blend modes. Blend modes are located in the Merge node since that is where one layer gets composited over another. Let’s take an example where you want to use the Screen mode to make a foreground image look more like a reflection.

The Merge node has a variety of controls built into it for creating just about every compositing effect you need. Items you may be familiar with as Blend modes are located in the Apply Mode pop-up menu. You can use these mathematical compositing modes to combine the foreground and background layers together. A Blend slider allows you to fade the foreground input with the background.
NOTE: The Subtractive/Additive slider disappears when you choose any other Apply Mode option besides Normal, because the math would be invalid. This isn’t unusual; there are a variety of controls in the Inspector that hide themselves when not needed or when a particular input isn’t connected.

The Screen node is perfect for simulating reflections, and lowering Blend a bit lets you balance the foreground and background images. It’s subtle, but helps sell the shot.

TIP: You may have noticed that the Merge node also has a set of Flip, Center, Size, and Angle controls that you can use to transform the foreground image without needing to add a dedicated Transform node. It’s a nice shortcut for simplifying node trees large and small.

Creating and Using Text

In this next example, we’ll look at how to create a simple text object using the Text+ node. Then, we’ll see how to use the text generator’s alpha channel in another image to create a more complex composite.

Creating Text Using the Text+ Node

The Text+ node is the primary tool for creating 2D text in the Fusion page. If you are using DaVinci Resolve, this is also the same Text+ generator available in the Edit page. It is easily accessible right in the toolbar.

The Text+ node is an incredibly deep tool for creating text effects, with six tabs of controls for adjusting everything from text styling, to different methods of layout, to a variety of shading controls including fills, outlines, shadows, and borders. As sophisticated a tool as this is, we’ll only be scratching the surface in this example.

We’ll start with a MediaIn node that will serve as our background selected in the Node Editor. Clicking the Text+ button automatically creates a new Text+ node connected as the foreground input of a Merge node. The same behavior occurs if you are using Fusion Studio, with a Loader node.
Selecting a Text node opens the default Text panel parameters in the Inspector, and it also adds a toolbar at the top of the viewer with tools specific to that node. Clicking on the first tool at the left lets you type directly into the viewer, or you can type into the Styled Text field in the Inspector.

If you’re viewing the Merge, the text appears in the viewer superimposed against the background clip. Onscreen controls appear that let you rotate (the circle) and reposition (the red center handle and two arrows) the text, and we can see a faint cursor that lets us edit and kern the text using other tools in the viewer toolbar.

**Styling and Adjusting Text**

To style the text, you use the controls in the Inspector, modifying text style controls such as Font, Size, and Tracking to change the spacing between the letters.

**TIP:** Holding down the Command key while dragging any control in the Inspector “gears down” the adjustment so that you can make smaller and more gradual adjustments.
Selecting the Manual Kerning tool in the viewer toolbar (second tool from the left) reveals small red dots underneath each letter of text.

![The Manual Kerning tool in the viewer toolbar](image)

Clicking a red dot under a particular letter puts a kerning highlight over that letter.

To make manual kerning adjustments:

1. Option-drag the red dot under any letter of text to adjust that character’s kerning while constraining letter movement to the left and right. You can also drag letters up and down for other effects. Depending on your system, the kerning of the letter you’re adjusting might not update until you drop the red dot in place.

2. If you don’t like what you’ve done, you can open the Advanced Controls in the Inspector and clear either the kerning of selected letters or all manual kerning before starting over again.

![Option-dragging the little red dot revealed by the Manual Kerning tool to manually adjust kerning](image)

**Using Text as a Mask**

You can fill the text with a color or gradient, or you can use the text as a matte to cut the letters out of another image. First, we’ll drag another clip of a chalkboard covered with math from the Media Pool to the Node Editor as a disconnected MediaIn2 node.
Disconnecting and Reconnecting Nodes

If we start from the previous example that had a MediaIn as the background and the Text+ as the foreground to a Merge, we’ll need to do a little rearranging. Clicking the last half of the connection from the Text1 node to the Merge foreground input disconnects it.

![Clicking the last half of a connection to disconnect it (top), and the result with the text node disconnected (bottom)](#)

Connecting a MediaIn2 or Loader2 node onto the Merge1 node’s foreground input causes the entire viewer to be filled with the MediaIn2 (assuming we’re still viewing the Merge node). At this point, we need to insert the Text1 node’s image as an alpha channel into the MediaIn2 node’s connection, and we can do that using a MatteControl node.

![The updated composite, with two video images connected and the text node disconnected](#)

Using Matte Control Nodes

Select the MediaIn2 node, and click the Matte Control button in the toolbar to add it between the MediaIn2 and Merge1 nodes. (To tidy up, I’ve moved the nodes around a bit in the screenshot.)

The MatteControl node has numerous uses. Among them is taking one or more alpha channels, mattes, or images that are connected to the Garbage Matte, Solid Matte, and/or foreground inputs, combining them, and using the result as an alpha channel for the image that’s connected to the background input. It’s critical to make sure that the image you want to add an alpha channel to is connected to the background input of the MatteControl node, or the MatteControl node won’t work.
With this done, connecting the Text+ node’s output, which has the alpha channel, to the MatteControl node’s Garbage Matte input, is a shortcut we can use to make a mask, matte, or alpha punch out a region of transparency in an image.

Keep in mind that it’s easy to accidentally connect to the wrong input. Because inputs rearrange themselves depending on what’s connected and where the node is positioned (and, frankly, the colors can be hard to keep track of when you’re first learning), it’s key to make sure that you always check the tooltips associated with the input you’re dragging a connection over to make sure that you’re really connecting to the correct one. If you don’t, the effect won’t work, and if your effect isn’t working, the first thing you should always check is whether you’ve connected the proper inputs.

One alternate method of connecting nodes together is to hold down the Option key while dragging a connection from one node’s output and dropping it onto the body of another node. This opens a pop-up menu from which you can choose the specific input you want to connect to, by name. Note that the menu only appears after you’ve dropped the connection on the node and released your pointing device’s button.

Once the Text1 node is properly connected to the MatteControl node’s Garbage Matte input, a text-shaped area of transparency is displayed for the graphic if you load the MatteControl node into the viewer.
Customizing Matte Control Nodes

You can use the Inspector to change some parameters to get the result you want. In the Inspector controls for the MatteControl node, revealing the Garbage Matte controls exposes parameters for modifying how the Garbage Matte input is applied to the image. For example, you can choose to have the text mask filled with the image instead of cutting a hole in the image.

Using Transform Controls in the Merge Node

The Merge node includes a set of transform parameters in the Inspector that specifically affect the foreground input’s image. This makes it quick and easy to adjust a foreground image to match the background without requiring another node.

NOTE: When connecting two images of different sizes to a Merge node, the resolution of the background image defines the output resolution of that node. Keep that in mind when you run into resolution issues.

You can use the Size slider to resize the foreground.
Building a Simple Green-Screen Composite

Taking another step forward in compositing, the next example shows how you can equate a multilayered Timeline like the one in DaVinci Resolve’s Edit page to nodes in Fusion’s node tree. We’ll use DaVinci Resolve, but understanding how layers map to nodes can be helpful for anyone new to dealing with a node-based interface. In this example, we’ll create a simple composite using a green-screen key and two other layers to create a news story.

Mapping Timeline Layers to Nodes in Fusion

This composite involves three layers in a Timeline. The Timeline consists of a background graphic on video track 1, a green-screen clip on video track 2, and a foreground graphic on video track 3.

Background on video track 1 (top left), green-screen clip on video track 2 (bottom), and graphic file on video track 3 (top right)

Implied in a timeline-based system is that higher numbered video tracks appear as the more forward, or frontmost, element in the viewer. Video track 1 is the background to all other video tracks. Video track 3 is in the foreground to both video track 1 and video track 2.
TIP: If using DaVinci Resolve, you can bring all three layers from the Edit page into Fusion by creating a Fusion clip. For more information on creating Fusion Clips, see Chapter 64, “Getting Clips into Fusion” in the DaVinci Resolve Reference Manual or Chapter 3 in the Fusion Reference Manual.

In Fusion, each video clip is represented by a MediaIn in the Fusion page or a Loader in Fusion Studio. In our example below, the MediaIn2 is video track 2, and MediaIn 1 is video track 1. These two elements are composited using a Merge node (foreground over background, respectively). The composite of those two elements becomes the output of the first Merge node, which becomes the background to a second Merge. There is no loss of quality or precomposing when you chain Merges together. MediaIn3 represents video track 3 and is the final foreground in the node tree since it is the topmost layer.

The initial node tree of the three clips we turned into a Fusion clip
With this node tree assembled to mimic the video layers, we can focus the rest of this example on adding the nodes we’ll need to each branch of this tree to create the green-screen composite.

**Pulling a Green-Screen Key Using the Delta Keyer**

To make this composite, you need to create transparency behind the newscaster. When working in a node tree, you must become accustomed to rearranging existing nodes to make room for new ones. You’ll often move nodes off to the side or up above to make room for the additional nodes.

The DeltaKeyer node is the main tool used for green-screen keying. It attaches to the output of the node that represents the green screen—in our example, that is the MediaIn2 node. With the MediaIn2 selected, pressing Shift-Space opens the Select Tool dialog where you can search for and insert any node. Below we have added the DeltaKeyer after the MediaIn2 node but prior to being merged with the background.

The DeltaKeyer node is a sophisticated keyer that is capable of impressive results by combining different kinds of mattes and a clean-plate layer, but it can also be used very simply if the background that needs to be keyed is well lit. And once the DeltaKeyer creates a key, it embeds the resulting alpha channel in its output, so in this simple case, it’s the only node we need to add. It’s also worth noting that, although we’re using the DeltaKeyer to key a green screen, it’s not limited to keying green or blue only; the DeltaKeyer can create impressive keys on any color in your image.

With the DeltaKeyer selected, we’ll use the Inspector controls to pull our key by quickly sampling the shade of green from the background of the image. To sample the green-screen color, drag the Eyedropper from the Inspector over the screen color in the viewer.
As you drag in the viewer, an analysis of the color picked up by the location of the Eyedropper appears within a floating tooltip, giving some guidance as to which color you’re really picking. Meanwhile, if viewing the Merge in a second viewer, we get an immediate preview of the transparency and the image we’ve connected to the background.

The original image (left), and after sampling the green screen using the Eyedropper from the Inspector (right)

When we’re happy with the preview, releasing the pointer button samples the color, and the Inspector controls update to display the value we’ve chosen.

No matter how good the composite may look, once you’ve selected the screen color to pull a key, you need to load the DeltaKeyer node into the viewer itself. This allows you to evaluate the quality or density of the alpha channel created by the key. Above the viewer, click the Color button in the viewer toolbar, or click in the viewer and press C to switch the viewer between the RGB color channels of the image and the alpha channel.
Loading the DeltaKeyer into the viewer and clicking the Color button to view the alpha channel being produced.

Black in a matte represents the transparent areas, while white represents the opaque areas. Gray areas represent semi-transparency. Unless you are dealing with glass, smoke, or fog, most mattes should be pure white and pure black with no gray gray areas. If a close examination of the alpha channel reveals some fringing in the white foreground of the mask, the DeltaKeyer has integrated controls for post-processing of the key and refining the matte. Following is a quick checklist of the primary adjustments to make.

After making the screen selection with the Eyedropper, try the following adjustments to improve the key.

- Adjust the Gain slider to boost the screen color, making it more transparent. This can adversely affect the foreground transparency, so adjust with care.
- Adjust the Balance slider to tint the foreground between the two non-screen colors. For a green screen, this pushes the foreground more toward red or blue, shifting the transparency in the foreground.

Clicking the third of the seven tabs of controls in the DeltaKeyer Inspector opens up a variety of controls for manipulating the matte.

Initial adjustments in the matte tab may include the following parameters:

- Adjust the lower and upper thresholds to increase the density in black and white areas.
- Very subtly adjust the Clean Foreground and Clean Background sliders to fill small holes in the black and white matte. The more you increase these parameters, the more harsh the edges of your matte become.
In this case, raising the Clean Foreground slider a bit eliminates the inner fringing we don’t want, without noticeably compromising the edges of the key.

The original key (left), and the key after using the Clean Foreground slider (right)

With this accomplished, we’re happy with the key, so we load the Merge1 node back into the viewer, and press C to set the Color control of the viewer back to RGB. We can see the graphic in the background, but right now it’s too small to cover the whole frame, so we need to make another adjustment.

The final key is good, but now we need to work on the background

**Dealing with Spill**

The DeltaKeyer can handle any screen color that may bounce off the background and land on your subject. This bounce screen light is called spill. However, instead of using one node to handle the matte creation and the spill correction, consider disabling this in the DeltaKeyer and remove the spill using a separate color correction node.

To disable spill suppression in the DeltaKeyer, do the following.

- Select the matte tab in the Inspector.
- From the Replace Mode drop-down menu, choose Source. This uses the color from the original source image, effectively disabling any spill correction in the DeltaKeyer.
The Replace Mode menu determines how spill suppression is handled in the DeltaKeyer.

Spill can now be handled using a color correction node placed directly after the DeltaKeyer or branched from the original MediaIn or Loader node and combined with a MatteControl.

Branching the original image with one branch for the DeltaKeyer and a second for color correction.

**Masking a Graphic**

Next, it's time to work on the top video track: the news graphic that will appear to the left of the newscaster. The graphic we will use is actually a sheet of different logos, so we need to cut one out using a mask and position it into place.

A graphic of multiple logos that must be cropped down to isolate just one.
The easiest way to crop a MediaIn or Loader node is to add one of the mask shapes from the toolbar directly to it. Selecting the MediaIn or Loader node and clicking the Rectangle mask from the toolbar will crop, or mask off, the graphic.

Masking the logo using a Rectangle mask connected directly to a Merge node

Now, all we need to do is to use the onscreen controls of the Rectangle mask to crop the area we want to use, dragging the position of the mask using the center handle, and resizing it by dragging the top/bottom and left/right handles of the outer border.

As an extra bonus, you can take care of rounded corners when masking a graphic by using the Corner Radius slider in the Inspector controls for the Rectangle mask to add the same kind of rounding.

Moving and resizing the mask to fit our logo, and rounding the edges using the Corner Radius Inspector control

For a simple over-the-shoulder graphic, masking the image may be all you need to do, but masking an image does not change the actual dimensions of the graphic. It only changes the area you see. So, accurately positioning the graphic based on the center of the composite becomes more difficult, and any type of match moving would give incorrect results because the graphic has a different resolution than the background. To fix this resolution mismatch, you can place a Crop node after the MediaIn to change the actual dimensions of the graphic layer.

Adding a Crop node after the masked MediaIn to center the cropped logo on the background

With the Crop node selected, the viewer toolbar includes a Crop tool.

Selecting the crop tool in the viewer toolbar
You can crop the image by dragging a bounding box around it. Unlike a mask which creates a small window you view the image through, a crop effectively changes the resolution of the graphic to the crop bounding box size.

![Crop tool and cropped logo](image)

Dragging a bounding box using the Crop tool (left), and the cropped logo now centered on the frame (right).

**NOTE:** The Resize, Letterbox, and Scale nodes also change the resolution of an image.

At this point, we’re all set to move the logo into place. Because the logo is the foreground input to a Merge, you can select the Merge2 node, load it into the viewer, and use the built-in Center X and Y controls or the onscreen controls to place the logo where you want it and make it a suitable size.

![Placing the logo](image)

Placing the logo using the foreground input transform controls of the Merge2 node.
Chapter 81

Rotoscopying with Masks

This chapter covers how to use masks to rotoscope, one of the most common tasks in compositing.

Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to Masks and Polylines</td>
<td>1441</td>
</tr>
<tr>
<td>Mask Nodes</td>
<td>1441</td>
</tr>
<tr>
<td>Polyline Types</td>
<td>1442</td>
</tr>
<tr>
<td>Converting Polylines from One Type to Another</td>
<td>1443</td>
</tr>
<tr>
<td><strong>How to Use Masks with Other Nodes</strong></td>
<td>1444</td>
</tr>
<tr>
<td>Attaching Masks to an Image for Rotoscopy</td>
<td>1444</td>
</tr>
<tr>
<td>Combining Multiple Masks</td>
<td>1446</td>
</tr>
<tr>
<td>Mask Inputs on Other Nodes</td>
<td>1446</td>
</tr>
<tr>
<td><strong>Creating and Editing Polylines In-Depth</strong></td>
<td>1449</td>
</tr>
<tr>
<td>The Polyline Toolbar</td>
<td>1449</td>
</tr>
<tr>
<td>Selecting a Specific Polyline</td>
<td>1449</td>
</tr>
<tr>
<td>Polyline Creation Modes</td>
<td>1450</td>
</tr>
<tr>
<td>Protection Modes</td>
<td>1451</td>
</tr>
<tr>
<td>Closing Polylines</td>
<td>1451</td>
</tr>
<tr>
<td><strong>Selecting and Adjusting Polylines</strong></td>
<td>1452</td>
</tr>
<tr>
<td>Polyline Points Selection</td>
<td>1452</td>
</tr>
<tr>
<td>Moving Polyline Points</td>
<td>1452</td>
</tr>
<tr>
<td>Smoothing a Polyline Segment</td>
<td>1453</td>
</tr>
<tr>
<td>Linearizing a Polyline Segment</td>
<td>1453</td>
</tr>
<tr>
<td>Transforming Individual or Multiple Points</td>
<td>1453</td>
</tr>
<tr>
<td>Deleting Selected Points</td>
<td>1453</td>
</tr>
<tr>
<td>Editing Bézier Handles</td>
<td>1454</td>
</tr>
</tbody>
</table>
Introduction to Masks and Polylines

Polylines are splines that are used whenever a control is animated with a motion path or when a node’s effect is masked with a drawn shape. They are also used in the Paint and Grid Warp nodes. In a more basic form, polylines are used to control the animation in the Spline Editor. Since these splines are used for just about everything, they are extremely flexible, with a considerable amount of controls, modes, and options. This chapter offers an overview of polylines and their operation, with specific information on how to use them for masks.

Mask Nodes

Mask nodes create an image that is used to define transparency in another image. Unlike other image creation nodes in Fusion, mask nodes create a single channel image rather than a full RGBA image. The most used mask tool, the Polygon mask tool, is located in the toolbar.

For more information on these mask tools, see Chapter 107, “Mask Nodes” in the DaVinci Resolve Reference Manual or Chapter 46 in the Fusion Reference Manual.
Polygon Mask
Polygon masks are user-created Bézier shapes. This is the most common type of polyline and the basic workhorse of rotoscoping. Polygon mask tools are automatically set to animate as soon as you add them to the Node Editor.

B-Spline Masks
B-Spline masks are user-created shapes made with polylines that are drawn using the B-Splines. They behave identically to polyline shapes when linear, but when smoothed the control points influence the shape through tension and weight. This generally produces smoother shapes while requiring fewer control points. B-Spline mask tools are automatically set to animate as soon as you add them to the Node Editor.

Bitmap Masks
The Bitmap mask allows images from the Node Editor to act as masks for nodes and effects. Bitmap masks can be based on values from any of the color, alpha, hue, saturation, luminance, and the auxiliary coverage channels of the image. The mask can also be created from the Object or Material ID channels contained in certain 3D-rendered image formats.

Mask Paint
Mask Paint allows a mask to be painted using Fusion’s built-in vector paint nodes.

Wand Mask
A Wand mask provides a crosshair that can be positioned in the image. The color of the pixel under the crosshair is used to create a mask, where every contiguous pixel of a similar color is also included in the mask. This type of mask is ideal for isolating color adjustments.

Ellipse, Rectangle, and Triangle Masks
These are primitive shape masks. For more information on these mask tools, see Chapter 107, “Mask Nodes” in the DaVinci Resolve Reference Manual or Chapter 46 in the Fusion Reference Manual.

Ranges Mask
Similar to the Bitmap mask, the Ranges mask allows images from the Node Editor to act as masks for nodes and effects. Instead of creating a simple luminance-based mask from a given channel, Ranges allows spline-based selection of low, mid, and high ranges, similar to the Color Corrector node.

Polyline Types
You can draw polylines using either B-Spline or Bézier spline types. Which you choose depends on the shape you want to make and your comfort with each spline style.

Bézier Polylines
Bézier polylines are shapes composed of control points and handles. Several points together are used to form the overall shape of a polyline.
Each control point has a pair of handles used to define the exact shape of the polyline segments passing through each control point. Adjusting the angle or length of the direction handles will affect whether that segment of the polyline is smooth or linear.

If you’re familiar with applications such as Adobe Photoshop or Illustrator, you’ll already be familiar with many of the basic concepts of editing Bézier polylines.

**B-Spline Polylines**

A B-Spline polyline is similar to a Bézier spline; however, these polylines excel at creating smooth shapes. Instead of using a control point and direction handles for smoothness, the B-Spline polyline uses points without direction handles to define a bounding box for the shape. The smoothness of the polyline is determined by the tension of the point, which can be adjusted as needed.

**Converting Polylines from One Type to Another**

Just because you created a shape using a B-Spline or polyline, that doesn’t mean you’re stuck with the controls you started with. You can convert any shape from B-Spline to Bézier, or Bézier to B-Spline, as needed.

**To switch a shape between Polyline and B-Spline controls:**

- Right-click a shape in the viewer and choose Convert Bézier Spline to B-Spline or Convert B-Spline to Bézier from the spline’s contextual menu (only the appropriate option will be displayed).

When converting from one type to another, the original shape is preserved. The new polyline generally has twice as many control points as the original shape to ensure the minimum change to the shape. While animation is also preserved, this conversion process will not always yield perfect results. It’s a good idea to review the animation after you convert spline types.
How to Use Masks with Other Nodes

Typically, a node applies its effect to every pixel of an image. However, many nodes have mask inputs that can be used to limit the effect that node has on the image.

Masks are single-channel images that can be used to define which regions of an image you want to affect. Masks can be created using primitive shapes (such as circles and rectangles), complex polyline shapes that are useful for rotoscoping, or by extracting channels from another image.

Each mask node is capable of creating a single shape. However, Mask nodes are designed to be added one after the other, so you can combine multiple masks of different kinds to create complex shapes. For example, two masks can be subtracted from a third mask to cut holes into the resulting mask channel.

Fusion offers several different ways you can use masks to accomplish different tasks. You can attach Mask nodes after other nodes in which you want to create transparency, or you can attach Mask nodes directly to the specialized inputs of other nodes to limit or create different kinds of effects.

Attaching Masks to an Image for Rotoscoping

There are two ways you’ll typically attach a Mask node, such as a Polygon node, so that it adds an alpha channel to an image for compositing later in the node tree.
Using a MatteControl Node
The MatteControl node is the main node used for combining masks in different ways and inserting the result into an image stream. The MatteControl node is attached downstream of the node outputting the image you want to rotoscope. You'll typically attach a Polygon or B-Spline node to the Garbage Matte input of the MatteControl node to use the spline as an alpha channel.

Feeding a Polygon node to a MatteControl node to perform roscoping

To use this setup, you'll load the MatteControl node into the viewer and select the Polygon node to expose its controls so you can draw and modify a spline while viewing the image you're rotoscoping. The MatteControl node's Garbage Matte > Invert checkbox lets you choose which part of the image becomes transparent.

Connecting a Mask to a MediaIn or Loader Node's Input
This method is a bit simpler but requires you to know that you can view one node while adjusting another node, even if that other node is disconnected. If you add an unattached Mask node such as a Polygon or B-Spline node, and then place a MediaIn or Loader node directly into the viewer while selecting the Mask node, you can draw a spline to rooscope the image.

Rotoscoping a MediaIn node using a disconnected Polygon node

When you’re finished roscoping, you simply connect the Polygon node’s output to the Loader node’s input, and an alpha channel is automatically added to that node.

Connecting a Polygon node to a MediaIn node to use a spline as an alpha channel

**TIP:** If you connect a Mask node to a MediaIn or Loader node’s effect input without any shapes drawn, that mask outputs full transparency, so the immediate result is that the image output by the MediaIn or Loader node becomes completely blank. This is why when you want to rooscope by connecting a mask to the input of a MediaIn or Loader node, you need to work within a disconnected Mask node first. Once the shape you’re drawing has been closed, connect the Mask node to the MediaIn or Loader’s input, and you’re good to go.
Combining Multiple Masks

Masks are designed to be added one after the other, with each Mask node acting as an additional layer of masking.

When a Mask node’s input is attached to another mask, a Paint Mode drop-down menu appears, which allows you to choose how you want to combine the two masks.

The default option is Merge, but you can also choose Subtract, Minimum, Maximum, Multiply, or any other operation that will give you the mask boolean interaction you need. Additionally, a pair of Invert and Solid checkboxes let you further customize how to combine the current mask with the one before it.

Mask Inputs on Other Nodes

Masks can be used for a variety of reasons, so there are several categories of mask inputs that different nodes include to accommodate these different uses. Incidentally, in most cases you can connect either masks or mattes to a mask input to take advantage of that input’s functionality.

**TIP:** If you select a node with an empty effect mask input, adding a Mask node automatically connects to the open effect mask input.
Effects Mask Inputs
Almost every node in Fusion has an Effect mask input (colored blue), which lets you choose which parts of the image will or will not be affected by that node.

![A Blur node with a Polygon node masking its effect](image)

While masks (or mattes) are connected via an input, they are actually applied “post effect,” which means the node first applies its effect to the entire image, and then the mask is used to limit the result by copying over unaffected image data from the input.

![A Polygon node used as a mask to limit the Blur node's effect](image)

Although many nodes support effects masking, there are a few where this type of mask does not apply—notably Savers, Time nodes, and Resize, Scale, and Crop nodes.

**TIP:** Effects masks define the domain of definition (DoD) for that effect, making it more efficient.

Pre-Masking Inputs
Unlike effect masks, a pre-mask input (the name of which is usually specific to each node using them) is used by the node before the effect is applied. This usually causes the node to render more quickly and to produce a more realistic result. In the case of the Highlight and the Glow nodes, a pre-mask restricts the effect to certain areas of the image but allows the result of that effect to extend beyond the limits of the mask.
The advantage to pre-masking is that the behavior of glows and highlights in the real world can be more closely mimicked. For example, if an actor is filmed in front of a bright light, the light will cause a glow in the camera lens. Because the glow happens in the lens, the luminance of the actor will be affected even though the source of the glow is only from the light.

In the case of the DVE node, a pre-mask is used to apply a transformation to a selected portion of the image, without affecting portions of the image outside of the mask. This is useful for applying transformations to only a region of the image.

Garbage Matte Inputs

Garbage Matte inputs (usually colored gray) are used to exclude light stands, rigging, and boom microphones that intrude upon masks being pulled via blue-screen and green-screen keys. In the following example, a lighting stand to the left is removed from the image via a B-Spline node’s mask connected to the Garbage Matte input of the DeltaKeyer node.

A B-Spline node is connected to the Garbage Matte input of a DeltaKeyer node to eliminate a light stand at the left of frame

**TIP:** You can quickly add a mask node to the Effect/Solid/Garbage Matte inputs of a keyer node by right-clicking the header bar of that node in the Inspector and choosing whichever mask node you want to use from the Effect Mask, SolidMatte, and GarbageMatte submenus.

You choose whether a garbage matte is applied to a keying node as opaque or transparent in the Inspector for the node to which it’s connected.

Solid Matte

Solid Matte inputs (colored white) are intended to fill unwanted holes in a matte, often with a less carefully pulled key producing a dense matte with eroded edges, although you could also use a polygon or mask paint to serve this purpose. In the example below, a gentle key designed to preserve the soft edges of the talent’s hair leaves holes in the mask of the woman’s face, but using another DeltaKeyer to create a solid matte for the interior of the key that can be eroded to be smaller than the original matte lets you fill the holes while leaving the soft edges alone. This is also sometimes known as a hold-out matte.
Creating and Editing Polylines In-Depth

This section covers the Polygon node’s capabilities in depth.

The Polyline Toolbar

Whenever a node that contains one or more polylines is selected, the polyline is shown on all viewers and the Polyline toolbar is displayed along the side of each viewer. The toolbar contains several buttons that make switching polyline modes and options easy to access.

If you hover the pointer over any of the Polyline toolbar buttons, a tooltip that describes the button’s function appears. Clicking on a button will affect the currently active polyline or the selected polyline points, depending on the button.

You can change the size of the toolbar icons, add labels to the buttons, or make other adjustments to the toolbar’s appearance in order to make polylines easier to use. All the options can be found by right-clicking on the toolbar and selecting from the options displayed in the contextual menu.

Selecting a Specific Polyline

It is possible to have several polylines in the viewer at once if you select multiple Mask nodes in the Node Editor, so it’s important to be able to switch between polylines easily.

To make a polyline active, do one of the following:

- Click one of the polyline’s control points or segments.
- Press Tab and Shift-Tab to cycle between available polylines.
- Right-click in the viewer and choose the desired polyline by name from the Controls > Select menu.
Polyline Creation Modes

There are several different modes available from the toolbar for creating and modifying polylines. The specific mode used when a polyline is first added will depend on whether it is used as a path or a mask.

Each of the modes is described in more detail below.

Click Append

This mode is the default mode for mask creation. It’s used to quickly define the rough shape of the mask, after which you switch to Insert and Modify mode to refine the mask further.

To create a mask using the Click Append mode, do the following:

1. Select Click Append from the toolbar or press Shift-C.
2. Click the pointer where you want to start the shape.
3. Move and click the pointer to append a point to the last one.
4. To close the shape, place the mouse pointer over the first point created and click when the pointer changes shape.

When a shape is closed, the polyline is automatically switched to Insert and Modify mode.

Although the Click Append mode is rarely used with paths, it can be helpful when you know the overall shape of a motion path, but you don’t yet know the timing.

**TIP:** Holding Shift while you draw a mask constrains subsequent points to 45-degree angles relative to the previous point. This can be very helpful when drawing regular geometry.

Insert and Modify

Masks, which are created in Click Append mode, automatically switch to Insert and Modify mode when the mask shape is closed. You can also manually switch to this mode by clicking the Insert and Modify button in the toolbar or using the Shift-I keyboard shortcut. This mode makes it easier to add additional points and refine the shape of the mask. Dragging the control points or direction handles modifies existing points on the polyline.

Insert and Modify mode is also the default mode for creating motion paths. A new control point is automatically added to the end of the polyline, extending or refining the path, any time a parameter that is animated with a motion path is moved.
Draw Append
The Draw Append mode creates a freehand polyline shape directly on the viewer, like drawing with a pencil or a paintbrush. This mode is ideal to use in conjunction with a tablet and for the creation of garbage mattes and effect masks around complex shapes.

Protection Modes
In addition to the modes used to create a polyline, two other modes are used to protect the points from further changes after they have been created.

Modify Only
Modify Only mode allows existing points on the polyline to be modified, but new points may not be added to the shape.

TIP: Even with Modify Only selected, it is still possible to delete points from a polyline.

Done
The Done mode prohibits the creation of any new points, as well as further modification of any existing points on the polyline.

Closing Polylines
There are several ways to close a polyline, which will connect the last point to the first.

To close a polyline, do one of the following:
- Hover the pointer over the first point created, and then click on the point.
- Press Shift-O on the keyboard.
- Click the Close button on the polyline toolbar.
- Draw a polyline until you are ready to close the shape, and then right-click and choose Polygon:Polyline > Closed.
All these options are toggles that can also be used to open a closed polygon.

**Selecting and Adjusting Polylines**

To create the shape you need for a mask or a motion path, you need to know how to manipulate the splines. Fusion provides a number of simple techniques for selecting, moving, and smoothing a spline, but also includes more complex adjustment techniques for scale, skewing, and twisting a spline.

**Polyline Points Selection**

To select one or more control points on a polyline, do one of the following:

- Click directly on the control points.
- Lasso around the points.

To add or remove points from the current selection, do one of the following:

- Hold the Shift key to select a continuous range of points.
- Hold Command and click each control point you want to add or remove.
- Press Command-A to select all the points on the active polyline.

**TIP:** Once a control point is selected, you can press Page Down or Page Up on the keyboard to select the next control point in a clockwise or counterclockwise rotation. This can be very helpful when control points are very close to each other.

**Moving Polyline Points**

The selected polyline points can be moved using either the keyboard or the mouse.

To move selected control points using the pointer, do one of the following:

- Drag on the selected points anywhere in the viewer.
- Hold Shift while dragging to restrict movement to a single axis.
- Hold Option and drag anywhere in the viewer to move the selected control point.

To move selected control points using the keyboard, do one of the following:

- Press the Up or Down Arrow keys on the keyboard to nudge a point up or down in the viewer.
- Hold Command-Up or Down Arrow keys to move in smaller increments.
- Hold Shift-Up or Down Arrow keys to move in larger increments.
Smoothing a Polyline Segment

If you want to shape the polyline and control its slope, you can choose to smooth a spline segment by adjusting the Bézier direction handles.

**To smooth the selected points on an active polyline, do one of the following:**

– Press Shift-S.
– Click the Smooth button on the Polyline toolbar.
– Choose Smooth from the polyline’s contextual menu.

![The Smooth button in the toolbar (Shift-S)](image)

Linearizing a Polyline Segment

To make certain that a polyline segment is perfectly straight, that segment must be linearized. A linear segment aligns the Bézier direction handles with the segment and therefore has no curvatures. The segment is always drawn in a straight line between two points on the polyline.

**To linearize the selected points on an active polyline, do one of the following:**

– Press Shift-L.
– Click the Linear button on the polyline’s toolbar.
– Choose Linear from the polyline’s contextual menu.

![The Linear button in the toolbar (Shift-L)](image)

Transforming Individual or Multiple Points

**Select the points to be transformed, and then do one of the following:**

– Hold T and drag to twist.
– Hold S and drag to scale.
– Hold X and drag to scale horizontally only.
– Hold Y and drag to scale vertically only.
– Hold O and drag to offset the points perpendicular to the tangent.

The position of the pointer when the transformation begins becomes the center used for the transformation.

Deleting Selected Points

You can delete a selected point or group of points by pressing Delete or Backspace, choosing Delete from the contextual menu, or by clicking the Delete Point button in the toolbar. The shape of the polyline changes to reflect the removal of these points.
TIP: Deleting all the points in a polyline does not delete the polyline itself. To delete a polyline, you must delete the node or modifier that created the polyline.

Editing Bézier Handles

For Bézier polylines, each control point has two direction handles that adjust the slope of a curve through the control point. These direction handles appear only when the point is selected.

Dragging a direction handle makes adjustments to the curve of the segment that emerges from the control point. The direction handle on the opposing side of the control point will also move to maintain the relationship between these two handles.

To break the relationship between direction handles and adjust one independently, hold Command while dragging a handle. Subsequent changes will maintain the relationship, unless Command is held during each adjustment.

Hold Command to adjust one handle independently

If you want to adjust the length of a handle without changing the angle, hold Shift while moving a direction handle.

Point Editor

The Point Editor dialog can be used to reposition control points using precise X and Y coordinates. Pressing the E key on the keyboard will bring up the Point Editor dialog and allow you to reposition one or more selected control points.

The Point Editor dialog can be used to position control points

The dialog box contains the X- and Y-axis values for that point. Entering new values in those boxes repositions the control point. When multiple control points are selected, all the points move to the same position. This is useful for aligning control points along the X- or Y-axis.

If more than one point is selected, a pair of radio buttons at the top of the dialog box determines whether adjustments are made to all selected points or to just one. If the Individual option is selected, the affected point is displayed in the viewer with a larger box. If the selected point is incorrect, you can use the Next and Previous buttons that appear at the bottom of the dialog to change the selection.
In addition to absolute values for the X- and Y-axis, you can adjust points using relative values from their current position. Clicking once on the label for the axis will change the value to an offset value. The label will change from X to X-offset or from Y to Y-offset.

![The Point Editor dialog with Offset values](image)

If you are not sure of the exact value, you can also perform mathematical equations in the dialog box. For example, typing 1.0-5 will move the point to 0.5 along the given axis.

**Reduce Points**

When freehand drawing a polyline or an editable paint stroke, the spline is often created using more control points than you need to efficiently make the shape. If you choose Reduce Points from the polyline’s contextual menu or toolbar, a dialog box will open allowing you to decrease the number of points used to create the polyline.

![The Reduce Points button in the toolbar](image)

The overall shape will be maintained while eliminating redundant control points from the path. When the value is 100, no points are removed from the spline. As you drag the slider to the left, you reduce the number of points in the path.

**Shape Box**

If you have a polyline shape or a group of control points you want to scale, stretch, squish, skew, or move, you can use the shape box to easily perform these operations.

To enable the shape box, do one of the following:
- Click the Shape Box toolbar button.
- Choose Shape Box from the contextual menu.
- Press Shift-B.

![The Shape Box button in the Polyline toolbar](image)

If there are selected points on the polyline when the Shape Box mode is enabled, the shape box is drawn around those points. Otherwise, you can drag the shape box around the area of control points you want to include.
If you want to freely resize the shape box horizontally and vertically, you can drag a corner handle. Dragging a handle on the side of the shape box resizes the polyline along a specific axis.

Dragging a side handle resizes along a specific axis

Holding Command while dragging a shape box handle will apply adjustments from the center of the shape box, constraining the transformation to the existing proportions of the shape box. Holding Shift while dragging a corner handle affects only that handle, allowing skewed and non-uniform transformations.

Hold Shift while dragging a corner to perform non-uniform transformations

**Showing and Hiding Onscreen Polyline Controls**

It is often difficult to identify individual points when they are placed closely together. You can choose to display both points and their direction handles, just points, or just handles. These display mode options are selected using the Show Key Points and Show Handles toolbar buttons, or from the polyline’s context menu.

The Show Key Points and Show Handles buttons in the toolbar

You use these options to simplify the screen display when adjusting control points placed closely together and to avoid accidentally modifying controls and handles that are adjacent to the intended target.
Stop Rendering

While points along the polyline are being moved, the results are rendered to the viewer to provide constant interactive feedback. Although extremely useful, there are situations where this can be distracting and can slow down performance on a complex effect. To disable this behavior so renders happen only when the points stop moving, you can toggle the Stop Rendering button in the toolbar or select this option from the polyline contextual menu.

Roto Assist

You can enable the Roto Assist button in the toolbar when you begin drawing your shape to have points snap to the closest high-contrast edge as you draw the shape. The points that have snapped to an edge are indicated by a cyan outline.

There are three main Roto Assist options.

- **Multiple Points**: Allows adding multiple points along an entire edge with a single click instead of having to add each point individually.
- **Distance**: Defines the pixel range within which searching for an edge will take place.
- **Reset**: Used for resetting the snap attribute of the snapped points. After resetting, the points will become unavailable for tracking.

![The Roto Assist options in the toolbar](image)

Creating Softness Using Double Polylines

The standard soft edge control available in all Mask nodes softens the entire mask equally. However, there are times, particularly with a lot of motion blur, when softening part of the curve while keeping other portions of the curve sharp is required.

This form of softness is called non-uniform softness, which is accomplished by converting the shape from a single polyline to a double polyline. The double polyline is composed of two shapes: an inner and an outer shape. The inner shape is the original shape from the single polyline, whereas the outer shape is used to determine the spread of the softness. The further the outer shape gets from the inner shape, the softer that segment of the shape becomes.
A double polyline uses an inner and outer shape for non-uniform softness.

Converting a Single Polyline to a Double Polyline

To convert a mask into a double polyline, click the Double Polyline button in the Polyline toolbar or right-click in the viewer and select Make Outer Polyline from the mask’s contextual menu.

The shape will be converted into an inner and an outer polyline spline. Both polylines start with exactly the same shape as the original single polyline. This keeps the mask sharp to start with and allows any animation that may have already been applied to the shape to remain.

The control points on the outer shape are automatically parented to their matching points on the inner shape. This means that any changes made to the inner shape will also be made to the outer shape. The relationship is one-way; adjustments to the outer shape can be made without affecting the inner shape.
A dashed line drawn between the points indicates the relationship between the points on the inner and outer shapes.

**Adding Softness to a Segment**

The outer shape is drawn using a green dashed line instead of a solid line to help distinguish it from the inner shape.

**To select the outer soft edge shape, do one of the following:**
- Use the Tab key to cycle between the onscreen controls until the dashed outline is visible
- Right-click over a spline in the view and choose Controls > Select > Polygon: Outer Polygon.

Once the outer polyline is selected, you can drag any of the points away from the inner polyline to add some softness to the mask.

**TIP:** Press Shift-A to select all the points on a shape, and then hold O and drag to offset the points from the inner shape. This gives you a starting point to edit the falloff.

The farther the outer shape segment is from the inner shape, the larger the falloff will be in that area.

**Adding Additional Points to the Shape**

It is not necessary for every point on the inner shape to have a match on the outer shape, or vice versa. You can add additional control points to refine the shape of either shape.

Each polyline stores its animation separately; however, if a point is adjusted on the inner shape that is parented to a point on the outer shape, a keyframe will be set for both splines. Adjusting a parented point on the outer shape only sets a keyframe for the outer shape’s spline. If a point that is not parented is adjusted, it will only set a keyframe on the relevant spline. You can disable this behavior entirely for this polyline by selecting Polygon: Outer Polygon > Follow Inner Polyline from the contextual menu.

**Locking/Unlocking Point Pairs**

If you want to parent additional control points, you can select the points, right-click in the viewer, and choose Lock Point Pairs from the contextual menu for either spline. This will cause the selected point on the outer shape to become parented to the selected point on the inner shape.

Any animation already applied to either point is preserved when the points become parented.

To unlock a point so it is no longer parented, select the point, right-click in the viewer, and deselect Lock Point Pairs from the contextual menu.

**Animating Polyline Masks**

Animating masks is surprisingly easy. When Polygon or B-Spline masks are added to the Node Editor, the spline’s control points are automatically ready to be animated. All you have to do to animate a mask is move the playhead to a new frame and then change the shape of the mask. A new keyframe is added in the Spline Editor and Timeline Editor. This one keyframe controls the position of all control points for that mask at that frame. Once two or more keyframes have been created, the shape of the polygon or B-Spline is automatically interpolated from one keyframe to the next.
To adjust the overall timing of the mask animation, you edit the Keyframe horizontal position spline using the Spline Editor or Timeline Editor. Additional points can be added to the mask at any point to refine the shape as areas of the image become more detailed.

**Removing Animation from a Polyline Mask**

If you want a Polyline mask to remain static, you can remove the automatic animation setting. In the Inspector for the mask, right-click in the bottom of the panel where it says Right Click Here For Shape Animation. From the contextual menu, choose Remove Bézier Spline. If you decide you need to animate the mask at a later time, right-click in the same area again and choose Animate.

**Adding and Removing Points from an Animated Mask**

When adding points to an animated mask, the new point is fit into the shape at all keyframes. Deleting a point removes that point from all keyframes in the animated mask.

**Publishing Specific Control Points**

Although you can rapidly animate the entire shape of a polyline using a single keyframe, by default the Spline Editor and Timeline display only one keyframe for the entire shape at any given frame.

This default keyframing behavior is convenient when quickly animating shapes from one form to another, but it doesn’t allow for specific individual control points that need to be keyframed independently of all other control points for a particular shape. If you’re working on a complex mask that would benefit from more precise timing or interpolation of individual control points, you can expose one or more specific control points on a polyline by publishing them.

Be aware that publishing a control point on a polyline removes that point from the standard animation spline. From that point forward, that control point can only be animated via its own keyframes on its own animation spline. Once removed, this point will not be connected to paths, modifiers, expressions, or trackers that are connected to the main polyline spline.

**To publish a selected point or points, do one of the following:**

- Click on the Publish Points button in the Polyline toolbar.
- Select Publish Points from the Polyline’s contextual menu.

A new coordinate control is added to the Polyline mask controls for each published point, named Point 0, Point 1, and so on.
The onscreen control indicates published points on the polyline by drawing that control point much larger. Once a published point is created, it can be connected to a tracker, path, expression, or modifier by right-clicking on this control and selecting the desired option from the point’s contextual menu.

Using “Publish to Path” to Preserve Animation
When a point is published, any animation already applied to that point is removed. However, if you need to keep the animation, you can use the “Publish to Path” option. This Polyline contextual menu option publishes the selected points and converts their existing animation to a path. You can also use the Publish to Path button in the Polyline toolbar.

Using “Follow Published Points” to Add Points
There are times when you will need to have control points that lie between two other published points follow the motion of the published points, while still maintaining their relative offset and shape. For this reason, points in a Polyline mask can be set to “Follow Published Points” using the Polyline’s contextual menu.

When a point of an effect mask is set to follow points, the point will be drawn as a diamond shape rather than a small box.

When this mode is enabled, the new “following” control points will maintain their position relative to the motion of any published points in the mask, while attempting to maintain the shape of that segment of the mask. Unlike published points, the position of the following points can still be animated to allow for morphing of that segment’s shape over time.
Chapter 82

Paint

This chapter describes how to use Fusion’s non-destructive Paint tool to repair images, remove objects, and add creative elements.

Contents

Paint Overview 1463
Types of Paint Nodes 1463
Setting Up the Paint Node 1463
Setting the Paint Node’s Resolution 1464
Paint Node Workflow 1464
Select the Correct Paint Stroke Type 1465
Setting the Brush Size 1467
Choosing an Apply Mode 1467
Editing Paint Strokes 1471
Editing Paint Strokes in the Modifiers Tab 1471
Deleting Strokes 1472
Animating and Tracking Paint Strokes 1472
Animating with Write-On Controls 1473
Tracking a Paint Stroke 1473
Using the Planar Tracker with the Paint Tool 1475
Inverting the Steady Effect to Put the Motion Back In 1481
Painting a Clean Plate 1482
Paint Overview

The Paint node is a procedural paint tool, which means that each paint stroke is a live, editable object that’s drawn with properties that you can mix and match to address a wide variety of painting tasks. You can use it to paint masks, retouch images, perform beauty work, clone out objects, or even create motion graphics. Each element of a paint stroke can be altered long after you apply it. Since strokes are editable, you can apply, change, ignore, delete, and even reorder them in a node tree.

Types of Paint Nodes

There are two types of paint nodes in Fusion. The Paint node is a full-featured creative and retouch vector-based paint tool that requires an input on which to paint. The Mask Paint node lets you specifically paint an alpha channel to limit the area of an effect. It allows you to create paint strokes on an alpha channel without needing to have an input.

- The Paint node is located in the Paint category of the Effects Library.
- The Mask Paint node is located in the Mask category of the Effects Library.

The main difference between these two Paint tools is that the Mask Paint tool only paints on the Alpha channel, so there are no channel selector buttons. The Paint tool can paint on any or all channels. The majority of this chapter covers the Paint node, since it shares identical parameters and settings with the Mask Paint node.

Setting Up the Paint Node

The Paint node has two inputs. Typical of most Fusion nodes, the orange input background is the primary input for connecting the “canvas” or image to paint on, while the second blue input is an Effect Mask. Unlike the Mask Paint node, the Paint node requires a background input to begin painting.
**Setting the Paint Node’s Resolution**

No matter how you use the Paint node in your node tree, the Paint node assumes the resolution of the background input image as your working resolution for that operation. Although the Paint tool is in fact resolution independent and you can change this assigned resolution at any time, it’s essential to make sure you properly set the resolution of the media you’re working with, because it will affect operations such as motion tracking that you’ll want to use as part of your paint workflow.

Because of this, the Paint node requires a background input to set the resolution of the “canvas” you’ll be painting upon. To do this, you can set up a Paint node in the node tree in one of two ways: painting directly on an image or using Paint as the foreground.

**Painting Directly on an Image**

You can connect the image you want to paint on directly to the background input of the Paint node. This is the easiest and cleanest node tree construction, but it doesn’t provide much in terms of compositing flexibility.

![Image of Paint node inserted directly after the node it is painting on]

**Using Paint as the Foreground in a Merge Composite**

An alternative setup is to use a Background node to set the resolution for the Paint node, compositing the result over the actual background using a Merge node. Working this way lets you use the Merge node’s Apply Mode setting (also referred to as composite modes) to control how your paint strokes are composited against the image, but it does require a bit more setup.

![Image of Paint node composited over the image you want to paint on using the merge]

Setting this up requires some configuration of the nodes. The Background node must be fully transparent and, unless you are doing something simple like using the Stroke tool set to Color to paint over an image, you must drag the image you want to clone or smudge into the Source Tool field in the Paint node’s inspector. These steps are described in more detail later in this chapter.

**Paint Node Workflow**

You begin painting by first selecting the paint stroke type from the Paint toolbar above the viewer. There are ten stroke types to choose from as well as two additional tools for selecting and grouping paint strokes. The stroke types and tools are described in detail in Chapter 112, “Paint Node” in the DaVinci Resolve Reference Manual or Chapter 51 in the Fusion Reference Manual. The primary tool for
painting and cloning is the Stroke tool. The Stroke tool is a fully animatable and editable vector-based paint stroke and initially uses a duration of the entire global range.

Select the Correct Paint Stroke Type

Instead of having multiple dedicated Paint nodes for different operations, the procedural nature of Fusion’s Paint tool means there is just one tool with a variety of different stroke types. Each stroke type serves a different purpose. The Paint toolbar above the viewer allows you to choose between different stroke types and drawing tools. These are grouped into a few categories.

Single-Frame Stroke Types

The Multistroke and Clone Multistroke are explicitly designed for single-frame retouching paint jobs like removing raindrops in a shot that’s supposed to be a sunny day or removing scratch marks and dust when restoring vintage content. When handling these types of jobs, these two Multistroke options are faster than the other stroke types, but they’re not editable later on. This means you must set up the size and function of the brush as well as the duration for the paint stroke before you paint.

The duration of each of these stoke types is one frame by default, but this can be changed using the Stroke Duration slider in the Inspector. Multistroke and Clone Multistroke are basically the same tools, except Clone Multistroke automatically configures the tool for cloning. In contrast, the Multistroke requires you to set up the tool for cloning manually.

Editable Stroke Types

The Stroke and Polyline are similar in that they can be modified and animated at any time. Also, they both begin with a duration lasting the entire comp, but that also can be changed using the Keyframes Editor.

The Stroke Tool

One of the most flexible editable stroke types you’ll use for many tasks is the Stroke, because it is fully animatable and editable. You can animate all elements of the Stroke, and you can use the Write-on/Write-off parameters to control how the stroke appears onscreen. You can also connect to a tracker from the Center point of the Stroke if you want to make the stroke follow specific onscreen motion.

By default, the Stroke type does not expose control points for the shape of the path. You can move and track the center and rotation of the Stroke, but the individual control points that create the spline are hidden. To reveal the control points, you can open the Stroke Controls at the bottom of the Inspector and click the Make Editable button.
The Stroke’s control points can be revealed using the Make Editable button.

Although the Stroke type is the most flexible, that flexibility can come at a performance penalty if you’re painting hundreds of strokes on a frame. For larger numbers of strokes that do not need to be animated, it’s better to use Multistroke or Clone Multistroke, as these are more processor efficient.

The Polyline Stroke Tool

The Polyline Stroke acts more like a drawing tool than a paintbrush. It includes the same functionality as the Stroke tool, except that it is created not by dragging or “painting” like a paintbrush, but by clicking to create a spline path, as you do with masks and motion paths. Without even creating a stroke in the viewer, the Polyline Stroke can connect to existing polylines like a mask or a motion path.

If a motion path is published, right-clicking on the Shape Animation label at the bottom of the Polyline Stroke’s Stroke Controls allows you to use the Connect To menu to assume the shape of a motion path or mask. You can also use this method if you import SVG graphics and want to “paint-on” the outlines.

Shape Drawing Tools

Five shape-based drawing tools allow you to draw shapes and either fill them with a color or clone an area from a source image. All these tools act similarly to the Stroke and Polyline stroke type in that they are editable at any time and have a default duration spanning the entire global range of the comp. However, you can edit the duration at any time in the Keyframes Editor.
All of the Copy [Shape Name] stroke types require that you connect the source node you are cloning from into the Paint node, and set the Fill Type menu to Image.

Setting the Brush Size

After selecting the Stroke type, the Brush size can be set in the Inspector or more intuitively in the viewer. With the Paint node selected in the Node Editor and the pointer positioned over the viewer, you can see an outline of the current brush size. To change the brush size, hold down the Command key and drag. The circle changes size, so you can set it relative to other objects you may be painting over.

Choosing an Apply Mode

The Apply Mode buttons determine the functionality of the paintbrush. There are eight Apply modes that set the brush to do things like paint a color, clone from a source, smudge an area, or remove thin wires.
Picking a Paint Color

There are several ways to pick the paint color and opacity for a colored brush stroke. You use the Fill button in the row of Apply modes when you want to paint with a solid color.

To select a color for the paint brush, do one of the following:

– Click the color swatch to open a standard OS Color Picker window.
– Drag the Eyedropper into the viewer.
– Drag inside the color chooser to select a saturation and luminance. Drag on the sidebars to change the hue and transparency.

When you paint, each stroke is unpremultiplied, so adjusting the Alpha slider in the Inspector does not affect what you apply to the RGB channels. However, changing opacity affects all four channels.

Cloning from the Frame

Choosing the Clone Apply Mode allows you to paint from one area of an image over another area. This is the most common use of the Paint tool. It allows you to remove objects or artifacts from a clip by covering them up with another area of the frame. Depending on the Stroke type chosen, you may clone on either a single frame or for the entire duration of the clip.

You can use the Clone Apply Mode to clone from the same image connected to the Paint node’s background input or a different source from the node tree.
To clone from a different area of the same frame:

1. Select a Stroke type from the Paint toolbar above the viewer.
2. Using the size slider in the Brush controls section of the Inspector, set the size of the brush.
3. From the Apply Mode buttons, select the Clone mode.
4. Option-click over the area in the viewer you want to use as the source. A dot appears showing you the center of what you’re sampling from.

5. Paint over the area you want to cover up using the source pixels.

When trying to erase objects or artifacts from a clip using the Clone Apply Mode, it can sometimes be easier if you sample from a different frame on the same clip. This works well when the object you are trying to clone out moves during the clip, revealing the area behind the object. Sampling from a different frame can use the revealed background by offsetting the source frame.

To clone from a different frame of the same clip:

1. Select a Stroke type from the Paint toolbar above the viewer.
2. Set the size of the brush.
3. From the Apply Mode buttons, select the Clone mode.
4. Drag the clip (MediaIn or Loader) from the Node Editor into the Source Tool field in the Inspector.
5 Click the Overlay checkbox to see the current frame and the offset frame superimposed.

6 Drag the Time Offset slider to select the source frame you want to use.

7 Option-click over the area in the viewer you want to use as the source or to offset the source frame’s position.

Overlay shows two frames overlapped with Time Offset, allowing you to clone from one frame onto another.

8 Paint over the area you want to cover up using the source pixels.

The plane is half painted out using on the Overlay with Time Offset.

9 Disable the Overlay checkbox.

The Clone Apply Mode can use a different frame from the same clip.

**TIP:** When using a Clone Apply Mode, you can hold down the O key instead of clicking the Overlay checkbox in Inspector to see the Overlay. Releasing the O key will return to normal viewing without the Overlay.
Editing Paint Strokes

Once you’ve painted using the Stroke or Polyline stroke type, you can change the look of the stroke by selecting it and updating the parameters in the Inspector. Selecting the stroke requires you to switch to the selection tool in the Paint toolbar above the viewer. Using the Paint node’s selection tool, you can either click once on a stroke or drag a bounding box around a stroke to select it for editing.

**TIP:** To select multiple strokes, you can Shift-click or Command-click to select and deselect multiple specific strokes, or you can drag a selection box around all strokes you want to select.

Although you can make changes in the Tools tab in the Inspector, the Paint node uses both the Tools tab and the Modifiers tab. In the Tools tab, you can create new brush strokes and select a stroke in the viewer to edit. The Modifiers tab presents a list of all the strokes for the selected Paint node, which makes it easy to modify any previously created paint stroke.

**NOTE:** Multistroke and Clone Multistroke each only appear as one item in the Modifiers tab no matter how many strokes you create using those tools. Those two tools are not editable after creating them.

The same controls you used in the Tools tab to create the strokes are located in the Modifier’s tab to modify them. You can also animate each individual stroke.

Editing Paint Strokes in the Modifiers Tab

When you paint a stroke, the settings for that stroke appear in the Inspector’s Modifiers tab. You can then change the settings in the Tools tab for the next stroke you are about to paint. Each time you click, drag, and release the pointer button, you create a new stroke. Each stroke is numbered in the Modifiers tab, where it can be selected and edited.
Once you stop painting a stroke, it’s added to the Modifiers tab along with an additional Stroke modifier that represents the next stroke. For instance, if you paint your first stroke, the Modifiers tab shows your stroke as Stroke1 and then a stroke 2 as well, which represents the next stroke you create. You always have one more stroke in the Modifiers tab than strokes in the viewer.

### Deleting Strokes

There are two ways you can delete paint strokes.

**To delete any individual stroke, do the following:**
1. Select the Paint node.
2. Click the Modifiers tab.
3. Right-click over the Stroke header you want to delete and choose Delete from the menu.

**To delete all paint strokes you’ve made on every frame, do one of the following:**
- Click the reset button in the upper-right corner of the Inspector.
- Delete the Paint node in the Node Editor.

### Animating and Tracking Paint Strokes

In some ways, animating paint strokes is no different than animating any other effect in the Inspector. Each parameter that can be animated includes a gray diamond Keyframe button along the right side. Clicking the Keyframe button sets a keyframe on the current frame and enables auto-keyframe mode for the parameter. However, more commonly, the paint stroke is tracked using one of Fusion’s trackers, or for motion graphics, animated using the Write-On Start and End sliders.
Animating with Write-On Controls

The Stroke and Polyline stroke types include Write-On controls located in the Stroke controls section of the Inspector. These Write-On controls animate the appearance of a stroke along the path. You can animate the Write-On controls using either the Stroke Animation drop-down menu or using the Start and End sliders.

Stroke Animation Drop-Down Menu

The Stroke Animation drop-down menu includes six options for auto-animating a paint stroke. The first two options do not truly animate the stroke as much as set a duration. The Limited Duration option uses the Duration slider to set the number of frames the stroke is onscreen.

To auto-animate the stroke, you can choose one of the three Write options or the Trail option.

Choosing Write On automatically creates a write-on animation. The duration is set by two keyframes that get added when you choose Write On from the menu. The Start keyframe is set on the frame where you first created the stroke. The End keyframe is added on the current frame when you choose Write On from the menu. The remaining options in the menu set their Start and End keyframes similarly but change the direction of the animation based on the menu selection.

Write-On Start and End Parameters

The Write-On Start and End parameters allow you to manually control the start point and end point along any stroke’s path, and use keyframes to animate each parameter individually. The Start parameter determines the point at which the stroke begins, measured as a percentage offset from the beginning of the stroke’s path. For example, a Start value of 50 moves the starting point of the stroke to the middle of the stroke’s path. The End parameter works the same way but from the other end of the stroke. You can animate a stroke onscreen, creating a handwriting effect by setting keyframes for the End parameter from 0 to 100 over several frames.

Tracking a Paint Stroke

You can animate the position of a paint stroke using any of Fusion’s trackers. For instance, if you cloned out a flag pole from a clip, but the camera moves, you can track the flag pole and attach the resulting path to the paint stroke.

To attach a tracker to a paint stroke:

1. With the Paint node, select the Stroke brush type and clone out an object on a frame.
2. In the Paint toolbar above the viewer, click the Select tool.
3. Drag a selection box around the stroke to select it.
4. Right-click the center control on the stroke, and then choose Stroke1:Center > Modify With > Tracker Position.
Right-clicking over the Stroke’s Center control in the view allows you to apply a tracker modifier.

5. Click the Modifiers tab to view the Tracker controls.

6. From the Node Editor, drag the MediaIn for the image you painted on, and drag it into the Tracker Source field in the Inspector.

7. Click the Track Forward button.

8. After tracking, at the bottom of the Inspector, use the Tracker 1 X Offset/Y Offset controls to reposition the paint stroke, if necessary.

**Tracking a Group of Paint Strokes**

You can assign a tracker to multiple strokes by adding the stroke to a group and connecting the tracker to the group. Instead of connecting each individual stroke, the group’s center is used for all of the strokes. Assuming the motion of each object is consistent in the same direction, as it would be objects “nailed to the set”, then applying the tracker to the group makes cloning multiple objects out with a single paint node very easy.
To group paint strokes, do the following:

1. Drag a bounding box, Shift-click, or Command-click to select every stroke that you want to group together.

2. Click the Paint Group button in the Paint toolbar.

The group’s onscreen controls replace the controls for each paint stroke, and the Modifiers tab in the Inspector shows the group’s parameters. The individual strokes are still editable by selecting Show Subgroup Controls in the Modifiers tab of the Inspector. The group then comes with a Center, Angle, and Size control for connecting to a tracker.

Using the Planar Tracker with the Paint Tool

Here’s an example that dives deeper into a workflow where we use the Paint tool with the Planar Tracker for retouching a clip. We’ll eliminate some facial scars on an actor’s forehead in a commercial by combining the Paint node with the PlanarTracker node, illustrating a common way of using these two powerful tools together.

The actor has some scars on his forehead that the director would like painted out.
Because this is a clip in motion, we can’t just paint out the scars on the man’s forehead; we need to deal with the motion so that the paint work we do stays put on his face. In this case, a common workflow is to analyze the motion in the image and use it to apply a “steady” operation, pinning down the area we want to paint in place so we can paint on an unmoving surface.

Setting Up the Planar Tracker for Stabilization

The best way to do this is to use the Planar Tracker, so we’ll add the PlanarTracker node after the MediaIn1 node, such that the image connects to the background input of the PlanarTracker node. As always, it’s important to be careful about which input you connect for the effect to work properly.

Adding a PlanarTracker node to analyze and steady the part of the image we want to paint on

With the PlanarTracker node selected and loaded in the viewer, a viewer toolbar appears with a variety of tools for drawing shapes and manipulating tracking data. The Planar Tracker works by tracking flat surfaces that you define by drawing a shape around the feature you want to track. When you first create a PlanarTracker node, you can immediately begin drawing a shape, so in this case, we draw a simple polygon over the man’s forehead since that’s the feature we want to steady in preparation for painting.

We draw a simple box by clicking once each on each corner of the man’s forehead to create control points, and then clicking the first one we created to close the shape.

Drawing a shape over the man’s forehead to prepare for Planar Tracking

In the Inspector, the PlanarTracker node has tracking transport controls that are similar to those of the Tracker. However, there are two buttons, Set and Go, underneath the Operation Mode menu, which defaults to Track, since that’s the first thing we need to do. The Set button lets you choose which frame to use as the “reference frame” for tracking, so you click the Set button first before clicking the Track Forward button below.
Setting a reference frame at the beginning of the range of frames we want to track.

**TIP:** The Set button lets you supervise a Planar Track in progress and stop it if you see it slipping, making adjustments as necessary before clicking Set at the new frame to set a new reference before continuing to track forward towards the end of the clip.

The Pattern controls let you set up how you want to handle the analysis. Of these controls, the Motion Type menu is perhaps the most important. In this particular case, Perspective tracking is the analysis we want. Still, in other situations, you may find you get better results with the Translation, Translation/Rotation, and Translation/Rotation/Scale options.

Once you initiate the track, a series of dots appears within the track region shape you created to indicate trackable pixels found. A green progress bar at the bottom of the Timeline ruler lets you see how much of the shot is remaining to track.

**NOTE:** If nothing happens when you track, or it starts to track and then stops, that’s your cue that there isn’t enough trackable detail within the shape you’ve drawn for the Planar Tracker to work, and your best bet is to choose a different location of the image to track.
Once the track is complete, you can set the Operation Mode of the PlanarTracker node’s controls in the Inspector to Steady.

Setting the PlanarTracker node to Steady

You’ll immediately see the image warped as much as is necessary to pin the tracked region in place for whatever operation you want to perform. If you scrub through the clip, you should see that the image dynamically cornerpin-warps as much as is necessary to keep the forehead region within the shape you drew pinned in place. In this case, this sets up the man’s head as a canvas for paint.

Steadying the image results in warping as the forehead is pinned in place for painting

At this point, you’re ready to paint out those scars.

Connecting the Paint Node

Although you could paint directly on the image by connecting the Paint node after the Planar Tracker, it gives you more control over the process if you merge the Paint node over the top of the steadied image. To do that, you’ll add a Merge after the Planar Tracker and then connect a Background node into the foreground of the Merge. Insert a Paint node after the background, and you are ready for this process.

Paint node merged over the top of a steadied Planar Tracker

Making the Background Node Transparent

The Background node must be fully transparent; otherwise, you are painting on the solid color instead of the Merge background image. To make the background transparent, drag the Alpha channel sidebar all the way up in the Color Picker.
Selecting the Stroke and Clone Mode

With the Paint node selected and set up, the next thing we want to do is to select the Stroke tool. The Stroke tool is the tool of choice when you want to paint out features or paint in fixes to subjects within the frame that need to remain in place for the entire shot.

Next, choose the Clone mode from the Apply Controls. In this example, we'll clone part of the man's face over the scars to get rid of them. Choosing the Clone mode switches the controls of the Paint node to those used for cloning.
Setting a Clone Source

The Paint node clones from the connected Input image unless you instruct it otherwise. If you are just painting a color over the background image, then you are good to go. However, if you plan on using the merge's steadied background image for cloning with the Paint tool, you must set that image as the Paint node's source. To set the clone source for the Paint node, you drag the PlanarTracker node into the Source Tool field in the Inspector.

Any node can be dragged into the Source Tool field when cloning with the Paint tool.

With the Stroke tool selected in the Paint toolbar, the Clone mode selected in the Inspector controls, and the Source for cloning added to the Source Tool field, we're ready to start painting. If we move the pointer over the viewer, a circle shows us the paint tool, ready to go.

To use the clone brush, first hold down the Option key and click somewhere on the image to identify the source area of the clone. In this example, we'll sample from just below the first scar we want to paint. After Option-clicking to sample the image, you can click to begin painting anywhere in the frame.

Setting an offset to sample for cloning (left), and dragging to draw a clone stroke (right)

If you don't like the stroke you've created, you can undo with Command-Z and try again. We repeat the process with the other scar on the man's forehead, possibly adding a few other small strokes to make sure there are no noticeable edges, and in a few seconds, we've taken care of the issue.

Original image (left), and after painting out two scars on the man's forehead with the Stroke tool set to Clone.
Inverting the Steady Effect to Put the Motion Back In

At this point, scrubbing through the clip shows that the paint strokes we’ve made are indeed sticking to the man’s forehead as we need them to do. Now we just have to invert the transform that the Planar Tracker applied to restore the clip back to the way it was, except now with the painted fix attached in the process. This ends up being a two-part process, but the first part is the simplest.

We select and copy the PlanarTracker node coming before the Merge node, and paste a copy of it after. This copy has all the analysis and tracking data of the original PlanarTracker node.

With the second PlanarTracker node selected, we go into the Inspector and turn on the Invert Steady Transform checkbox, which inverts the steady warp transform to restore the image back to the way it was.

This is just one example of how to set up a Planar Tracker and Paint node. In some instances, you made need to do more work with masks and layering, but the above example gives you a good starting point.
Painting a Clean Plate

On simple clips, planar tracking the clone paint strokes may work fine. In other cases, you may not be able to steady the clip, or the strokes might appear like they are "bubbling." Paint is just a single stroke repeated over multiple frames. Each painted frame has the potential to appear differently than the one before or after. Often, the more reliable way to use paint is by creating what is referred to as a "clean plate." Create one good painted frame and freeze it. Then use the Planar Tracker to track the cleaned area over the top of the original. The benefit is that there is only a single paint stroke instead of repeated paint strokes that potentially show unwanted artifacts. For this next example, we continue with the previous clip, but now the technique is to freeze, mask, and composite just a single frame of the fixed forehead over the original clip.

Creating a Freeze Frame and Clean Plate

As in the previous example, you still track the clip using the Planar Tracker. After tracking, you can branch out from the MediaIn (or Loader node if you are using Fusion Studio) into a Time Stretcher to create the freeze frame.

Disable the default Keyframe in the Time Stretcher and enter the frame you want to freeze. If you have already performed a Planar Track, then entering the frame you set as the Reference Frame is usually a good frame to freeze.

To create the clean plate, you connect the paint node to the output of the Time Stretcher. Clone over the areas you want to hide, and you now have a single clean frame. Now you need to composite the clean area over the original.

Isolating the Painted Forehead

First, we need to mask out just the man's painted forehead. We can do this by connecting a MatteControl node to the output of the Paint node and then connect a Polygon node to the garbage matte input. This lets us draw a shape with the Polygon node and use it as a mask to crop out the man's painted forehead.
TIP: When it comes to using masks to create transparency, there are a variety of ways to connect one—for example, (a) attach the image to the background input of a Brightness/Contrast node and attach a Polygon mask node to the effect mask input. On the Brightness/Contrast node, enable the Alpha channel and lower the Gain slider to darken a hole, or (b) using Channel Booleans to copy channel data to the alpha from a Polygon node attached to the foreground input and the image attached to the background input.

Drawing a Polygon Mask

After moving the playhead to the first frame of the clip, we’re ready to draw a mask to isolate the “clean plate” forehead. Loading the MatteControl1 into the viewer and selecting the Polygon1 node so that we see its tools in the viewer toolbar sets us up for drawing a polygon.

Drawing shapes using the Polygon node is similar to shape drawing in other spline-based environments, including the Color page:

- Clicking once draws a corner control point.
- Clicking and dragging creates a Bézier curve.
- Clicking the first control point you created closes a shape.

We click and drag to create a shape that outlines the man’s forehead, and when we close the shape, we see exactly the opposite of what we want, a hole in the middle of the image.

Before fixing this, we drag the Soft Edge slider in the Inspector to the right to blur the edges just a bit.

Inverting the Garbage Input

Selecting the MatteControl1 node, we open the Garbage Matte controls and click the Invert checkbox, which immediately gives us the result we want, of the forehead in isolation, ready for compositing.
Compositing the Painted Forehead Against the Original Image

Almost finished. Next, we'll add a Merge node to layer the fixed forehead over the original image being output by the MediaIn node.

We create a Merge node connected to the output of the PlanarTracker node, and then we connect the MatteControl’s output to the green foreground input of the Merge node. This puts the cropped and fixed forehead on top of the original image.

Match Moving the Mask to the Shot

Now we have the best of both worlds: a fixed forehead and the background of the shot looking good. However, if we select the Polygon node and then scrub forward in the clip, the fixed forehead mask drifts out of sync with the motion of the shot, so we have one remaining issue. Fortunately, match moving the mask to move with the shot is really simple.
Selecting the first PlanarTracker node that comes right after the MediaIn node, and choosing Track from the Operation Mode menu, reveals a Create Planar Transform button at the bottom of the listed controls. Clicking this button creates a new, disconnected Planar Transform node in the Node Editor, which has the transforms from the Planar Tracker baked in. Unlike the Planar Tracker, the Planar Transform is intended for use with masks. With the Planar Transform created, there is no longer a use for the Planar Tracker, and it can be disconnected or deleted from the Node Editor.

We can insert this new node into the node tree to use it by holding down the Shift key and dragging the node over the connection between the Polygon node and the MatteControl node, dropping it when the connection highlights.

With the new Planar Transform node inserted, the Polygon automatically moves to match the motion of the forehead that was tracked by the original PlanarTracker node, and it animates to follow along with the movement of the shot. At this point, we’re finished!

The final painted image, along with the final node tree.
Chapter 83

Using the Tracker Node

This chapter shows the many capabilities of the Tracker node in Fusion, starting with how trackers can be connected in your node trees, and finishing with the different tasks that can be performed.

Contents

Introduction to Tracking 1487
Tracker Node Overview 1488
Modes of the Tracker Node 1488
Basic Tracker Node Operation 1488
Connect to a Tracker’s Background Input 1488
Analyze the Image to be Tracked 1489
Apply the Tracking Data 1490
Viewing Tracking Data in the Spline Editor 1492
Tracker Inspector Controls 1493
Motion Tracking Workflow In Depth 1494
Connect the Image to Track 1494
Add Trackers 1494
Refine the Search Area 1497
Perform the Track Analysis 1497
Tips for Choosing a Good Pattern 1498
Using the Pattern Flipbooks 1499
Using Adaptive Pattern Tracking 1499
Dealing with Obscured Patterns 1500
Dealing with Patterns That Leave the Frame 1500
Setting Up Tracker Offsets 1501
Introduction to Tracking

Tracking is one of the most useful and essential techniques available to a compositor. It can be roughly defined as the creation of a motion path from analyzing a specific area in a clip over time. Fusion includes a variety of different tracking nodes that let you analyze different kinds of motion. Once you have tracked motion on a clip, you can then use the resulting data for stabilization, motion smoothing, matching the motion of one object to that of another, and a host of other essential tasks.

Types of tracking nodes in Fusion:

- **Tracker:** Follows a relatively small, identifiable feature or pattern in a clip to derive a 2D motion path. This is sometimes referred to as point tracking.

- **Planar Tracker:** Follows a flat, unvarying surface area in a clip to derive a 2½D motion path including perspective. A planar tracker is also more tolerant than a point tracker when some tracked pixels move offscreen or become obscured.

- **Camera Tracker:** Tracks multiple points or patterns in a clip and performs a more sophisticated analysis by comparing those moving patterns. The result is a precise recreation of the live-action camera in virtual 3D space.

Each tracker type has its own chapter in this manual. This chapter covers the tracking techniques with the Tracker node.
Tracker Node Overview

The Tracker node is a single node that actually performs tracking, stabilizing, matching moving, and corner-pinning operations. Since the Tracker node can transform the foreground input, it can be used to generate tracks and then operate as a Merge in a match move or corner-pin setup. Or you can use it to produce tracking data only and then publish that data to other nodes in the Node Editor.

Modes of the Tracker Node

The Tracker node is an incredibly flexible tool often used multiple times in a composite to help with dozens of tasks. However, most of those tasks can be boiled down into just a few operations. The Tracker node has four operation modes that cover the majority of tracking situations.

Stabilizing

You can use one or more tracked patterns to remove all the motion from the sequence or to smooth out vibration and shakiness. When you use a single tracker pattern to stabilize, you stabilize only the X and Y position. Using multiple patterns together, you are able to stabilize position, rotation, and scaling.

Match Moving

The reverse of stabilizing is match moving, which detects position, rotation, and scaling in a clip using one or more patterns. Instead of removing that motion, it is applied to another image so that the two images can be composited together.

Corner Positioning

Corner positioning tracks four patterns that are then used to map the four corners of a new foreground into the background. This technique is generally used to replace signs or mobile phone screens. The Planar Tracker node is often a better first choice for these types of tracking tasks.

Perspective Positioning

Perspective positioning again tracks four patterns to identify the four corners of a rectangle. Each corner is then mapped to a corner of the image, rescaling and warping the image to remove all apparent perspective. The Planar Tracker node is often a better first choice for removing perspective from a clip.

Basic Tracker Node Operation

All tracking workflows consist of three fundamental steps.

1. Attach an image you want to track to the yellow background input of the Tracker node.
2. Set the tracking pattern and analyze the clip to create a path.
3. Apply the tracking data to stabilize, match move, corner pin, or remove perspective.

Connect to a Tracker’s Background Input

You start by connecting the output of the image you want to track to a Tracker node’s background input. The Tracker node analyzes the image that’s attached to its background input.

You can insert the Tracker node serially with other nodes if you intend to use the Tracker node itself to do a simple stabilization operation or if you want to use it to perform the function of a Merge node in a match move or corner-pin operation.
Tracker node connected serially so it can both track and transform the input images.

However, if you're just using a Tracker node to analyze data for use with multiple nodes elsewhere in the comp, you could choose to branch it and leave its output disconnected to indicate that Tracker node is a data repository. Please note that this is not necessary; serially connected Tracker nodes can be linked to multiple other nodes as well.

Tracker connected as a branch to indicate it is linked to other nodes and not used directly.

**Analyze the Image to be Tracked**

After constructing the node tree and inserting the Tracker where you want, you can set up the tracker in the viewer. You identify one or more features in the image that you wish to track (referred to as patterns) by adding trackers (there's one by default) and positioning them using the onscreen controls in the viewer. After the Tracker node analyzes the clip, the resulting tracking data is stored within that Tracker node. Keyframes, one per frame, indicate the Tracked Center X and Y data that has been saved, while a motion path shows the path of tracked data in the viewer.

A motion path that indicates the tracked motion, and tic marks that indicate tracking data keyframes.
Apply the Tracking Data

The resulting tracking data stored within the Tracker node is used to stabilize, match move, corner pin, or remove perspective in one of two ways.

Method 1: Use the Tracker node to match move and merge

You can connect a foreground image to the Tracker node and apply the motion from the analyzed background image.

![Using a Tracker node in line for a match move](image)

Setting the Operation parameter in the Operation tab in the Inspector to Match Move, Corner Position, or Perspective Position always applies the motion to the foreground input (if one is connected). This is an easy workflow for simple situations. In this scenario, you can use the Tracker node to replace a Merge node since Tracker nodes include all the same functionality as a Merge.

![Using a Tracker node to do a match move and merge, all in one](image)

Method 2: Connect specific parameters to the Tracker Node

Alternatively, you can connect the tracking data from the Tracker node to the specific parameters of other nodes that will actually do the work, for instances where setting up a match move isn’t just a matter of transforming a foreground image. Each Tracker node and each pattern within the Tracker node publishes its data for other nodes to use without directly linking to them in the node tree. For example, in the following node tree, an Ellipse node is being used to isolate a glow effect for the ray gun prop.
The Tracker set up as a branch and connected using the Connect To menu

The ellipse needs to follow the motion of the ray gun, so a Tracker node is used to analyze the movement of the gun tip so that tracking data can be used to animate the ellipse. The ellipse is not connected to the tracker directly via the foreground input but indirectly through the Connect To contextual menu.

Applying the light of a ray gun by connecting tracking data to the center position of an Ellipse node

This is made easier by renaming the Tracker you created to something descriptive of what’s being tracked.

You can rename trackers in the Tracker List by double-clicking them and typing descriptive text

Once the tip of the ray gun has been tracked, this tracking data is then connected to the Center parameter of an Ellipse node that’s limiting a Glow effect by right-clicking the label of the Center parameter in the Inspector, and choosing Tracker1 > Ray Gun Glow: Offset position from the Connect to submenu of the contextual menu. All the data from every Tracker node in your node tree and every tracking pattern appears within this submenu, and since we named the Tracker, it’s easy to find. Choosing Offset position because it will place the center of the ellipse directly over the path. However, it also gives us the flexibility to offset the ellipse if need be, using the offset controls in the Inspector.
You can connect the data from a Tracker node to any other node’s parameter; however, you’ll most typically connect track data to center, pivot, or corner X/Y style parameters. When you use tracking data this way, it’s not necessary to connect the output of the Tracker node itself to anything else in your node tree; the data is passed from the Tracker to the Center parameter by linking it with the Connect To submenu.

**Viewing Tracking Data in the Spline Editor**

Tracking data can be seen in the viewer as a path or as a displacement spline in the Spline Editor. You can manipulate the tracking data in either place.

The Tracker uses a displacement spline by detail that indicates how far the tracking point is based on the original location. It is great for modifying velocity, but it doesn’t tell you anything about direction. If you need to nudge a few points in a certain direction, you can convert the displacement spline to an X and Y coordinate spline.

Right-clicking a parameter’s label lets you connect tracking data to it to animate it.

Right-click in the viewer to bring up a contextual menu. At the very bottom is a reference to the path the Tracker created, called Tracker1Tracker1Path:Polyline. Choosing it calls up a longer submenu where you can choose Convert to XY Path.
For more information on Displacement Splines, see Chapter 71, “Animating in Fusion’s Spline Editor” in the DaVinci Resolve Reference Manual or Chapter 10 in the Fusion Reference Manual.

**Tracker Inspector Controls**

The layout of the Tracker node’s tabs in the Inspector reflects this workflow. It’s divided into three main Tracker tabs, as well as the common Settings tab.

– **The Tracker Control tab**: This is where you create onscreen trackers with which to target patterns, and where the controls appear that let you perform the required track analysis.

![Tracker Control tab](image)

– **The Operations tab**: This is where you decide how the tracking data is used.

![Tracker Operations tab](image)

– **The Display Options tab**: This is where you can customize how the onscreen controls look in the viewer.
The Tracker Display Options tab

**Motion Tracking Workflow In Depth**

Tracker nodes serve two purposes. They provide a method to analyze an object you want to follow, and they serve as a container for the resulting track data. This allows you to use one node for analysis and to pass on that analysis to any other node that requires it. Following is a more detailed breakdown of the tracking process.

**Connect the Image to Track**

Regardless of whether you actually use the Tracker node itself to do anything with the tracking data, the image you want to track must be connected to the background input (yellow) of a Tracker node for there to be a successful analysis. While the Tracker node has a foreground input, it is initially ignored for purposes of tracking analysis, so even if you connect a foreground, the background is the only input used during the analysis process.

**Add Trackers**

Although each Tracker node starts with a single tracker pattern, a single node is capable of analyzing multiple tracking patterns that have been added to the Tracker List, enabling you to track multiple features of an image all at once for later use and to enable different kinds of transforms. Additional trackers can be added by clicking the Add button immediately above the Tracker List control.

To add an additional tracker, click the Add button in the Inspector
Multiple patterns are useful when stabilizing, match moving, or removing perspective from a clip. They also help to keep the Node Editor from becoming cluttered by collecting into a single node what would otherwise require several nodes.

**Working in the Tracker list:**

- **To select a tracker:** Click the name of the Tracker you want to select.
- **To rename a tracker:** You can rename trackers to make it easier to reference them later. For example, if you’re tracking a car door handle, you can name the Tracker “Car Handle” so it’s easy to find later. To do so, just double-click the default name of the Tracker in the Tracker list, type a new one, and press Return.
- **To delete a tracker:** Select a tracker and click the Delete button.
- **To disable, suspend, or re-enable trackers:** Click the checkbox to the left of each tracker’s name in the Tracker List. It’s a three-way toggle that switches between Enabled, Suspended, and Disabled.
  - **Enabled:** An Enabled tracker will re-track its pattern every time the track is performed. Its path data is available for use by other nodes, and the data is available for stabilization and corner positioning.
  - **Suspended:** When the checkbox appears gray, it is Suspended. In this state, it does not re-track its pattern when the track is performed. The data is locked to prevent additional changes, but the data from the path is still available for other nodes. The data is also available for advanced tracking modes like stabilization and corner positioning.
  - **Disabled:** A Disabled tracker does not create a path when tracking is performed. Its data is not available to other nodes or for advanced tracking operations like stabilization and corner positioning.

**Position the Pattern Boxes**

A pattern is the region of pixels that are targeted for tracking within an image using a pattern box. The pattern box is defined in the viewer by a rectangle when a tracker is active. A single Tracker node can have many pattern boxes, each targeting different patterns. Each tracked pattern will produce its own motion path.

Clicking any part of a tracker’s onscreen controls will select it. Selected pattern boxes are red, while deselected pattern boxes are green.

![A pattern box positioned over an eye you want to track](image)

When you add a Tracker node to the Node Editor, you start with one pattern box displayed in the viewer as a small rectangle. When the cursor is placed over the pattern rectangle, the control
expands and two rectangles appear. The outer rectangle has a dashed line, and the inner rectangle has a solid line. The outer rectangle is the search area, and the inner rectangle is the pattern.

If you need to select a new pattern, you can move the pattern box by dragging the small (and easily missed) handle at the top left of the inner pattern box.

To move a pattern in the viewer, drag it from the upper-left corner.

While moving the pattern box, an overlay pop-up appears, showing a zoomed version of the pixels contained within the rectangle to help you precisely position the pattern via the crosshairs within.

The pattern rectangle can also be resized by dragging on the edges of the rectangle. You want to size the pattern box so that it fits the detail you want to track, and excludes area that doesn’t matter. Ideally, you want to make sure that every pixel of the pattern you’re tracking is on the same plane, and that no part of the pattern is actually an occluding edge that’s in front of what you’re really tracking. When you resize the pattern box, it resizes from the center, so one drag lets you create any rectangle you need.

Resizing a pattern box to fit the tracking point on the ray gun

**TIP:** The magnified pattern box does not take viewer LUTs into account. When using Log content, it may make it easier to position the tracker if you temporarily insert a Brightness Contrast node between the source content and the yellow input of the tracker. You can use the Brightness Contrast node to temporarily increase the visibility of the region you are tracking.
Refine the Search Area

A second rectangle with a dotted border surrounds the pattern box. This is the search area. When progressing from one frame to another while tracking, the Tracker analyzes the region defined by the search area, which surrounds the last known tracker position in an attempt to relocate the pattern. The larger the search area, the better chance you have of successfully tracking fast moving objects, but the longer the track will take. However, there are some ways to optimize tracking for specific content.

For example, tracking a pattern that is moving quickly across the screen from left to right requires a wide search area but does not require a very tall one, since all movement is horizontal. If the search area is smaller than the movement of the pattern from one frame to the next, the Tracker will likely fail and start tracking the wrong pixels, so it’s important to take the speed and direction of the motion into consideration when setting the search area.

Perform the Track Analysis

Before you begin analyzing, you’ll need to make sure you’ve set a render range in the Time Ruler that corresponds to the range of frames during which the pattern is visible. This may be an entire clip or only a small portion of that clip. Depending on the type of motion you’re tracking, you may want to use the Adaptive Mode option to aid the analysis (see below for more details).

Once your options are set, you can use any of the tracking transport buttons at the top of the Inspector to start tracking. Once tracking has started, you cannot work in the Node Editor until it has completed.

To begin tracking, do one of the following:

– Click the Track Reverse button to track from the very end of the render range.
– Click the Track Backward from Current Frame button to track backward from the current playhead position.
– Click the Track Forward button to track from the very start of the render range.
– Click the Track Forward from Current Frame button to track forward from the current playhead position.
Pattern tracking will stop automatically when it reaches the end of the render range (or the start when tracking backward), but you can also interrupt it and stop tracking at any time.

**To stop tracking, do one of the following:**
- Click the Stop Tracking button in the tracker transports.
- Click Stop Render at the bottom of the Fusion window.
- Press the Escape key.

When tracking is complete, the path will be connected to the pattern. The path from that pattern can now be connected to another node or used for more advanced operations like stabilization and corner positioning.

Once the track is complete, assuming it’s good, you can use the various techniques in this chapter to use the track in your composition.

**Tips for Choosing a Good Pattern**

The Tracker works by searching each frame for the pixels contained in the pattern. In order for a track to be successful, a fairly high contrast and unique region of the image must be located in the footage. This process is known as pattern selection.

The first step in pattern selection is to review the footage to be tracked several times. Watch for candidate patterns that are visible through the entire range of frames, where the contrast is high and the shape of the pattern does not change over time. The more unique the pattern, the more likely the track is to be successful.

In addition to locating high contrast, defined patterns, watch for the frames where the pattern moves the most. Identifying the maximum range of a pattern’s motion will help to determine the correct size for the pattern search area.

It is not uncommon to have a scene that requires the use of several different patterns to generate a single path. This most often occurs because the pattern moves out of frame or is temporarily obscured by another scene element. Combining patterns into a single pattern is described later in the chapter.

**Selecting the Pattern’s Image Channels**

When a pattern of pixels is selected, the Tracker automatically selects the color channel used for tracking the pattern based on an analysis of each channel for contrast, clarity, and reliability. The channels selected are highlighted in the bars to the right of the Pattern display window in the node controls.

You can override the automatic channel selection by clicking the buttons beneath the bars for each channel to determine the channel used for tracking.

You can choose any one of the color channels, the luminance channels, or the alpha channel to track a pattern.
When choosing a channel, the goal is to choose the cleanest, highest contrast channel for use in the track. Channels that contain large amounts of grain or noise should be avoided. Bright objects against dark backgrounds often track best using the luminance channel.

**Selecting Patterns for Stabilization**

Selecting patterns for stabilization can be a tricky business. The location of the pattern, when it is selected, is used to determine precisely how the image will be stabilized. At least two patterns are required to correct for rotation; using three patterns will correct for scaling, and more will usually improve the quality of the solution.

Try not to select just any potentially valid pattern in the sequence, as some patterns will make the solution worse rather than better. To help with your selection, use the following guidelines when selecting patterns for stabilization.

- Locate patterns at the same relative depth in the image. Objects further in the background will move in greater amounts compared to objects in the foreground due to perspective distortion. This can confuse the stabilization calculations, which do not compensate for depth.
- Locate patterns that are fixed in position relative to each other. Patterns should not be capable of moving with reference to each other. The four corners of a sign would be excellent candidates, while the faces of two different people in the scene would be extremely poor choices for patterns.

**Using the Pattern Flipbooks**

Each pattern has a pair of thumbnail windows shown in the Inspector. The left window shows the selected pattern, while the right window is updated during the track to show the actual pattern that has been acquired for each frame.

![The Tracker Pattern Selection and Flipbook thumbnails](image)

Each pattern that’s stored is added to a Flipbook. Once the render is complete, you can play this Pattern Flipbook to help you evaluate the accuracy of the tracked path. If you notice any jumps in the frames, then you know something probably went wrong.

**Using Adaptive Pattern Tracking**

Even the most ideal pattern will usually undergo shifts in profile, lighting conditions, and other variables. These can adversely affect pattern recognition to the point that a pattern becomes unusable. The Tracker offers three modes of pattern acquisition during tracking that can help to correct these conditions. The modes can be set using the Adaptive Mode options in the Inspector.

![The Adaptive Mode options](image)
None
When the Adaptive mode is set to None, the pattern within the rectangle is acquired when the pattern is selected, and that becomes the only pattern used during the track.

Every Frame
When Every Frame is chosen, the pattern within the rectangle is acquired when the pattern is selected, and then reacquired at each frame. The pattern found at frame 1 is used in the search on frame 2, the pattern found on frame 2 is used to search frame 3, and so on. This method helps the Tracker adapt to changing conditions in the pattern.

Every Frame tracking is slower and can be prone to drifting from sub-pixel shifts in the pattern from frame to frame. Its use is therefore not recommended unless other methods fail.

Best Match Tracking
Best Match tracking works in much the same way as Every Frame tracking; however, it will not reacquire the pattern if the difference between the original pattern and the new one is too great. This helps to prevent cases where transient changes in the image cause the Tracker to become confused.

As a comparison between the two Adaptive modes, if a shadow passes over the tracker point, the Every Frame tracking mode may start tracking the shadow instead of the desired pattern. The Best Match mode would detect that the change from the previous frame’s pattern was too extreme and would not grab a new pattern from that frame.

The Adaptive mode is applied to all active patterns while tracking. If you only want some patterns to use the Adaptive mode, disable all other patterns in the list before tracking.

Dealing with Obscured Patterns
Often, an otherwise ideal pattern can be temporarily obscured (occluded) or blocked from tracking—for example, when tracking a car that passes behind a telephone pole.

In these situations, you divide the render range up into two ranges, the range before the pattern is obscured and the range after the pattern becomes visible again. After tracking the two ranges individually, the Tracker will automatically interpolate between the end of the first range and the start of the second.

If you need to edit the resulting motion path to account for any non-linear motion that takes place between the two tracked ranges, you can select the track path to expose a Node toolbar with controls for adjusting the control points on this path. For example, you can choose Insert and Modify mode to insert points in the non-tracked range to compensate for any nonlinear motion in the tracked pattern.

Dealing with Patterns That Leave the Frame
There are two options when a tracker leaves the frame. If the pattern re-enters the frame, you can treat it like an obscured pattern. If the pattern does not re-enter the frame, or it is undesirable to hand track portions of the movement, you can use the Track Center (Append) mode to select a new pattern.
The Track Center (Append) mode pop-up menu

The Track Center (Append) mode selects a new pattern that will continue to add keyframes to the existing path. The offset between the old pattern and the new pattern is automatically calculated to create one continuous path.

**To use the Track Center (Append) mode, do the following:**

1. When the pattern has become untrackable for some reason, stop analysis and move the playhead to the last frame that tracked successfully.
2. Choose Track Center (Append) from the Path Center pop-up menu in the Inspector.
3. Now, drag the Pattern selector to a new pattern that can be tracked from that point onward.
4. Restart tracking from the current frame.

When selecting a pattern to use in appending to an existing path, a pattern that is close to the old pattern and at the same apparent depth in the frame generates the best results. The further away the new pattern is, the more likely it is that the difference in perspective and axial rotation will reduce accuracy of the tracked result.

**Setting Up Tracker Offsets**

Often, it’s impossible to track the thing you want to apply an effect to. For example, the only pattern available for an accurate track is a button on an actor’s sleeve. However, the effect requires the person’s hand to be glowing. To cause the glow’s effect mask to be centered on the actor’s hand, it’s necessary to use the Tracker Offset control.

The X and Y Offset controls allow for constant or animated positional offsets to be created relative to the actual Tracker’s pattern center. The position of the offset in the viewer will be shown by a dashed line running from the pattern center to the offset position. You can also adjust the offset in the viewer using the Tracker Offset button. Clicking the button enables you to reposition the path while keeping the Tracker pattern in place.
Once an offset for a pattern is set, you can connect other positional controls to the Tracker’s Offset menu using the Connect To > Tracker: Offset Position option in the control’s contextual menu. The path created during the track remains fixed to the center of the pattern.

## Stabilizing with the Tracker Node

When a Tracker node is set to Match Move in the Operations tab, it is capable of a variety of functions. Applying the motion from the background clip to the foreground clip is the obvious functionality. However, the Match Move operation is also used for stabilizing footage to either completely remove motion from the scene or smooth existing motion.

Here are some common scenarios for stabilization that are handled when the Tracker is set to Match Move.

- A sequence that should be steady has vibrations or undesirable movement.
- A sequence that requires a smooth camera move suffers from jarring.

### Stabilization Using the Tracker Match Move Mode

Stabilizing motion completely removes the appearance of motion from the image. The motion from frame to frame is calculated, and the contents of the frame are transformed to return the image to a reference position. This position can be either the start or end of the sequence or a manually selected frame from the sequence.

Stabilization can correct for position with as little as one pattern. Two or more patterns are required to correct for rotation or scaling within the image.

When the Operation menu is set to Match Move, choosing BG only from the Merge operation menu stabilizes the background (yellow input) clip. Only the controls that are applicable for stabilization operations will appear in the Operation tab.

Several of the stabilization controls are always available, collected under the Match Move Settings disclosure button. These controls are available at all times because the Steady and Unsteady positions of a tracker are always published. This makes them available for connection by other controls, even when the Tracker’s operation is not set to match moving.
**Merge**

The Merge menu determines to which input connection the Tracking data is applied. When stabilizing an image to remove all motion, or smooth the motion, the Merge button must be set to BG Only.

**Edges**

The Edges menu determines whether the edges of an image that leave the visible frame are cropped, duplicated, or wrapped when the stabilization is applied. Wrapping edges is often desirable for some methods of match moving, although rarely when stabilizing the image for any other purpose. For more information on the controls, see Chapter 118, “Tracker Nodes” in the DaVinci Resolve Reference Manual or Chapter 57 in the Fusion Reference Manual.

**Position/Rotation/Scaling**

Use the Position, Rotation, and Scaling checkboxes to select what aspects of the motion are corrected.

**Match Move Settings**

Options for the Match Move settings include Pivot and Reference.

**Pivot Type**

The Pivot Type for the stabilization is used to calculate the axis of rotation and scaling calculations. This is usually the average of the combined pattern centers but may be changed to the position of a single tracker or a manually selected position.

**Reference**

The Reference controls establish whether the image is stabilized to the first frame in the sequence, the last frame, or to a manually selected frame. Any deviation from this reference by the tracked patterns is transformed back to this ideal frame.

As a general rule, when tracking to remove all motion from a clip, set the Merge mode to BG Only, the Pivot Type to Tracker Average or Selected Tracker, and the Reference control to Start, End, or Select Time.

**Smoothing Motion**

When confronted with an image sequence with erratic or jerky camera motion, instead of trying to remove all movement from the shot, you often need to preserve the original camera movement while losing the erratic motion.

The Start & End reference option is designed for this technique. Instead of stabilizing to a reference frame, the tracked path is simplified. The position of each pattern is evaluated from the start of the path and the end of the path along with intervening points. The result is smooth motion that replaces the existing unsteady move.

The Reference Intermediate Points slider is displayed when Start & End is selected to enable the smoothing of motion.

To preserve some of the curvature of the original camera motion, you can increase the value of the Reference Intermediate Points slider that appears when the Start & End reference mode is selected.

When tracking to create smooth camera motion, ensure that the Start & End reference mode is enabled and set the Merge mode to BG Only. It is recommended to leave the Pivot Type control set to Tracker Average.
Using the Tracker Node for Match Moving

A simple match moving example is shown at the beginning of this chapter, but this section presents additional details that you may not have been aware of. Examples of match moving include:

- A static CG element must be believably added to a moving sequence.
- Two sequences with different motions must be composited together.

Some clips may need to be stabilized so that an element from another source can be added to the shot. After the element or effect has been composited, the stabilization should be removed to make the shot look natural again.

Simple Match Moving

Match moving essentially applies the movement from the tracked clip to another clip. There are two ways to perform match moving. One method involves connecting other nodes, such as Transform or Merge, to a Tracker’s outputs. The other method is to stabilize an image by trying to remove all motion, but instead of setting the Merge menu to BG Only, set it to FG Over BG, FG Only, or in rare occasions, BG Over FG.

![Set the Merge menu to BG Only, FG Over BG, or BG Over FG](image)

When using this Merge menu, you connect a foreground image to the Tracker node’s input connection in the Node Editor.

![Connect a foreground image to the Tracker’s foreground input](image)

Enabling the FG Only mode will apply the motion from the background to the foreground, and the Tracker will only output the modified FG image. This result can later be merged over the original, allowing further modifications of the foreground to be applied using other nodes before merging the result over the background clip.

Corner Positioning Operations

The Corner Positioning operation maps the four corners of a foreground image to four patterns within the Tracker. This operation, or technique, is most commonly used for sign replacements.

The Corner Positioning operation of the Tracker requires the presence of a minimum of four patterns. If this operation mode is selected and there are not four patterns set up in the Tracker already, additional patterns will automatically be added to bring the total up to four.

When this mode is enabled, a set of drop-down boxes will appear to select which tracker relates to each corner of the rectangle. It has no effect when the Merge control option is set to BG Only.
Perspective Positioning Operations

The Perspective Positioning operation is used to remove perspective from a foreground image or apply the perspective from one sequence to another. This can be useful when you need to paint out an area that is distorted by perspective. Removing the perspective flattens the images for painting, and then another tracker adds the perspective back.

The Perspective Positioning operation of the Tracker requires the presence of a minimum of four patterns. If this operation mode is selected and there are not four patterns set up in the Tracker already, additional patterns will automatically be added to bring the total up to four.

When this mode is enabled, a set of drop-down boxes will appear to select which tracker relates to each corner of the rectangle. It has no effect when the Merge control option is set to BG Only.

Connecting to Trackers’ Operations

One of the most common applications for a tracked pattern is using the tracked position or path to drive the position of another node’s parameters. For example, tracking an eye in order to color correct the eye to blue using an effect mask. You start off by tracking the eye, and then create a color corrector with the desired settings. You create a mask in the shape of the eye and connect the Tracker’s position to the Center of the mask.

In addition to the path (called Offset Position), each pattern in a tracker publishes four other values for use as connections that are available to other nodes in the Node Editor.

You connect a node’s position parameters to a tracker by selecting the connection type from the controls contextual menu (for example, Transform 1: Center > Connect To > Tracker 1 > Offset Position).

There are five connection types automatically published by the tracker to connect to a position parameter in another node.

Steady Position

Steady Position can be used to stabilize footage in both X and/or Y to remove camera shake and other unwanted movement. The connection inverts the output of the tracked pattern’s motion. When you connect a Center parameter to the Steady Position of the Tracker, it will be placed at 0.5/0.5 (the center of the screen) by default at frame 1. You can change this using the Reference mode in the Tracker’s Operation tab.

Steady Angle

The Steady Angle mode can be used to stabilize footage in both X and/or Y to remove camera shake and other unwanted movement. When you connect a control, for example the Angle of a Transform, to the Steady Angle of the Tracker, it will be placed at 0 degrees by default at frame 1. This can be changed by means of the Reference mode in the Tracker’s Operation tab. From there on, the resulting motion of the Steady Angle mode will rotate into the opposite direction of the original motion.

So if the angle at frame 10 is 15 degrees, the result of the Steady Angle will be -15 degrees.

To use Steady Angle, you need at least two tracked patterns in your tracker. With just one point, you can only apply (Un)Steady Position.
Offset Position

An Offset Position is essentially the path generated by the tracker. It is the one you select when you want an object to follow the path. It is available for each single tracker in the Tracker node and refers to that single tracker only. When you connect the Center X and Y parameters to the offset position of the Tracker, the node’s center will follow exactly the path of that tracker. Connecting to single trackers is always useful when you want to match elements with object motion in your footage. For example, you could track a hand of your actor and attach a ball to the Tracker’s offset position, so that the ball follows the exact motion of the hand. Or you could track an element that needs rotoscoping and attach the mask’s center to the Tracker’s offset position.

Unsteady Position

After using the Steady Position, the Unsteady Position is used to reintroduce the original movement on an image after an effect or new layer has been added. The resulting motion from Unsteady Position is basically an offset in the same direction as the original motion.

Steady Size

The Steady Size connection outputs the inverse of the tracked pattern’s scale. When you connect a parameter, for example the Size of a Transform, to the Steady Size of the Tracker, it will be placed with a Size of 1 (i.e., the original size) by default at frame 1. This can be changed by means of the Reference mode in the Tracker’s Operation tab. The resulting size of the Steady Size mode will then counteract the size changes of the original motion. So if the actual size at frame 10 is 1.15, the result of the Steady Size will be 1 - (1.15 - 1) = 0.85.

To use Steady Size, you need at least two tracked patterns in your tracker. With just one point, you can only apply (Un)Steady Position.

Using the Outputs of a Tracker

The tracker outputs described above are published by each tracker pattern created in the Tracker node. Each Tracker node itself also publishes a Steady Position, Angle, Size and an Unsteady Position. The values of these Tracker node outputs are calculated using all the patterns in that tracker, as configured by the Match Move Settings controls in the Tracker’s Operation tab.

Rather than using the Tracker node to perform the Merge operation, an alternative and common way to use these published outputs is to create a match move by connecting the outputs to multiple nodes. A tracker is used to track a pattern, and then that data can be connected to multiple other nodes using the Connect To submenu.
As an example, to use the Connect To menu to perform a match move, do the following:

1. Track the background clip using at least two tracking patterns in the tracker.
2. In a different branch, add a Transform node to the background clip.

3. Right-click over the Transform’s Center and choose Connect to > Tracker1 > Steady Position.

4. Connect the foreground to a corner-positioned node, so you can position the corners of the foreground appropriately over the background.

5. Add another Transform node to the Node Editor after the Merge.

6. Connect the new Transform’s Center to the Tracker’s Unsteady Position. The image will be restored to its original state with the additional effect included.
To better understand how this works, imagine a pattern that is selected at frame 1, at position 0.5, 0.5. The pattern does not move on frame 2, so its position is still 0.5, 0.5. On the third frame, it moves 10 percent of the image’s width to the right. Now its position is 0.6, 0.5.

If a transform center is connected to the Steady Position output of the Tracker, the Transform node’s center is 0.5, 0.5 on the first and second frames because there has been no change. On frame 3, the center moves to 0.4, 0.5. This is the inverse of the horizontal motion that was tracked in the pattern, moving the image slightly to the right by 10 percent of the image width to counteract the movement and return the pattern of pixels back to where they were found.

**Using the Tracker as a Modifier**

Another technique for adding a tracker directly to a control is to add it as a modifier. Choosing the Tracker from the Modify With contextual menu does not use a Tracker node; it adds a modifier in the Inspector with a set of parameters almost identical to those found in the Tracker node itself. The benefit here is that the object that you want to follow the tracked path is automatically connected to the tracker modifier when you apply it.

The differences between a Tracker modifier and a Tracker node are as follows:

- The Tracker modifier can only track a single pattern.
- A source image must be set for the Tracker modifier.

The Tracker modifier can only output a single value and cannot be used for complex stabilization procedures, but it is a nice quick way to apply a tracker to a point that you need to follow.

**As an example, to apply the Tracker as a modifier, do the following:**

Imagine that you needed to track an actor’s eyes so that an unearthly, alien glow could be applied to the eyes.

1. Add an ellipse mask node to cover an actor’s eye.
2. In the Inspector, right-click on the mask’s Center parameter and from the contextual menu choose Ellipse1 Center > Modify With > Tracker Position.
Right-click over any Center Coordinate Control and choose Modify With > Tracker Position to add a Tracker modifier.

3. Click the Modifiers tab in the Inspector and drag the MediaIn1 node that you want to track into the Tracker Source field.

4. Click the Track Forward button to begin tracking the person’s eye.

5. Insert a Soft Glow node directly after the MediaIn and connect the Ellipse Mask to the white Glow Mask input.
You can set a different source image for the Tracker modifier by typing in the name of the node or dragging and dropping the node from the Node Editor into the Tracker Source field control. If you have a node (let’s call it node#1) connected to the node that contains the modifier (let’s call it node#2), the source image for the Tracker modifier will automatically be the node #1.


### Match Moving Text Example

This example takes you through a complete motion tracking task, and shows how you can create a very simple match-moving effect using the Tracker node, which is the Swiss army knife of trackers in Fusion.

#### Adding a Layer to Match Move

In the example composition, we have a Text1 node that’s creating a “Switzerland” title that’s composited over a drone shot flying over and around a mountain bridge. With the Text1 node selected, the onscreen controls that let you position the text it’s generating are visible in the viewer, and the text is positioned where we’d like it to start. Note that, with the Text node selected, even the part of the text that’s offscreen can still be seen as an outline showing us where it is.
Our goal for this composition is to motion track the background image so that the text moves along with the scene as the camera flies along.

**Setting Up Motion Tracking**

To set up for the motion track, we’ll begin by creating a disconnected Tracker node, using another method other than those seen previously. Right-click anywhere in the background of the Node Editor (preferably where you want the new node to appear), and choose Add Tool > Tracking > Tracker from the contextual menu to create a new Tracker node underneath the MediaIn node (or Loader node if you are using Fusion Studio).
Next, we’ll drag a connection from the MediaIn1 node to the Tracker1 node to automatically connect the source clip to the Tracker1 background input. This branches the output from the MediaIn1 node to the Tracker node so that the Tracker1 node processes the image separately from the rest of the node tree. This is not required, but it’s a nice organizational way to see that the Tracker node is doing an analysis that must be referred to in a way other than a “physical” connection.

A Simple Tracking Workflow

The Tracker node is the simplest tracking operation the Fusion page has, and while there are several ways of using it, an extremely common workflow is to use the Tracker node controls to analyze the motion of a subject in the frame with motion you want to follow, and then use the resulting motion path data by “connecting” it to the Center parameter of another node that’s capable of transforming the image you want to match move.

Positioning the Tracker Onscreen Control

When the Tracker node is selected, a single green box appears in the viewer, which is the default onscreen control for the first default tracker that node contains (seen in the Tracker List of the Inspector controls). Keep in mind that you only see onscreen controls for nodes that are selected, so if you don’t see the onscreen tracker controls, you know you need to select the tracker you want to work with. Loading the tracker you want to work with into the viewer is also the safest way to make sure you’re positioning the controls correctly relative to the actual image that you’re tracking.

If you position your pointer over this box, the entire onscreen control for that tracker appears, and if you click the onscreen control to select that tracker, it turns red. As with so many other tracker interfaces you’ve likely used, this consists of two boxes with various handles for moving and resizing them:

- The inner box is the “pattern box,” which identifies the “pattern” in the image you’re tracking and want to follow the motion of. The pattern box has a tiny handle at its upper-left corner that you use to drag the box to overlap whatever you want to track. You can also resize this box by dragging any corner, or you can squash or stretch the box by dragging any edge to make the box better fit the size of the pattern you’re trying to track. The center position of the tracker is indicated via X and Y coordinates.

- The outer box is the “search box,” which identifies how much of the image the tracker needs to analyze to follow the motion of the pattern. If you have a slow-moving image, then the default search box size is probably fine. However, if you have a fast-moving image, you may need to resize the search box (using the same kind of corner and side handles) to search a larger area, at the expense of a longer analysis. The name of that tracker is shown at the bottom right of the search box.
It's worth saying a second time that the handle for moving a tracker's onscreen control is a tiny dot at the upper-left corner of the inner pattern box. It's really easy to miss if you’re new to Fusion. You must click on this dot to drag the tracker around.

In this example, we’ll drag the onscreen control so the pattern box overlaps a section of the bridge right over the leftmost support. As we drag the onscreen control, we see a zoomed-in representation of the part of the image we’re dragging over to help us position the tracker with greater precision. For this example, the default sizes of the pattern and search box are fine as is.

Using the Tracker’s Inspector Controls to Perform the Analysis

At this point, let’s look at the Tracker node’s controls in the Inspector. There are a lot of controls, but for this simple example we only care about the main Tracker panel, with the tracking analysis buttons at the top, the tracking options below those, and the Tracker List underneath those. The Tracker List also has buttons for adding and deleting trackers; you have the option of adding multiple trackers that can be analyzed all at once for different workflows, but we don’t need that for now.
Additional controls over each tracker and the image channels being analyzed appear at the bottom, along with offset controls for each tracker, but we don’t need those now (at least not yet).

Again, this track is so simple that we don’t need to change the default behaviors that much, but because the drone is flying in a circular pattern, the shape of the pattern area is changing as the clip plays. Fortunately, we can choose Every Frame from the Adaptive Mode menu to instruct the tracker to update the pattern being matched at every frame of the analysis, to account for this.

Changing the Adaptive Mode of the Tracker node to Every Frame to account for the camera’s shift of perspective

Now, we just need to use the tracker analysis buttons at the top to begin the analysis. These buttons work like transport controls, letting you start and stop analysis as necessary to deal with problem tracks in various ways. Keep in mind that the first and last buttons, Track from Last Frame and Track from First Frame, always begin a track at the last or first frame of the composition, regardless of the playhead’s current position, so make sure you’ve placed your tracker onscreen controls appropriately at the last or first frame.

The analysis buttons, left to right: Track from Last Frame, Track Backward, Stop Tracking, Track Forward, Track from First Frame

For now, clicking the Track from Beginning button will analyze the entire range of this clip, from the first frame to the last. A dialog lets you know when the analysis is completed, and clicking the OK button dismisses it so you can see the nice clean motion path that results.

The analyzed motion path resulting from tracking a section of the bridge as the camera flies past

Viewing Motion Track Data in the Spline Editor

This is not a necessary part of the tracking workflow, but if you have an otherwise nice track with a few bumps in it, you can view the motion tracking data in the Spline Editor by viewing that tracker’s Displacement parameter curve. This curve is editable, so you can massage your tracking data in a variety of ways, if necessary.
Connecting Motion Track Data to Match Move

Now that we have a successful analysis, it’s time to use it to create the Match Move effect. To make this process easier, we’ll double-click the tracker’s name in the Tracker List of the Inspector, and enter a new name that’s easier to keep track of (heh). Adding your own names make that tracker easier to find in subsequent contextual menus and lets you keep track of which trackers are following which subjects as you work on increasingly complex compositions.

Now it’s time to connect the track we’ve just made to the text in order to start it in motion. After loading the Merge1 node into the viewer to see the text in context with the overall composite we’re creating, we’ll select the Text1 node to open its parameters in the Inspector, and click the Layout panel icon (second button from the left) to expose the Layout controls, which are the text-specific transform controls used to position the text object in the frame. These are the controls that are manipulated when you use the Text node onscreen controls for repositioning or rotating text.

The Center X and Y parameters, while individually adjustable, also function as a single target for purposes of connecting to tracking to quickly set up match moving animation. You set this up via the contextual menu that appears when you right-click any parameter in the Inspector, which contains a variety of commands for adding keyframing, modifiers, expressions, and other automated methods of animation including connecting to motion tracking.
If we right-click anywhere on the line of controls for Center X and Y, we can choose Connect To > Tracker1 > Bridge Track: Offset position from the contextual menu, which connects this parameter to the tracking data we analyzed earlier.

Immediately, the text moves so that the center position coincides with the center of the tracked motion path at that frame. This lets us know the center of the text is being match moved to the motion track path.

Offsetting the Position of a Match Moved Image

In fact, we want to offset the match-moved text, so it’s higher up in the frame. To do this, we select the Tracker1 node again and use the Y Offset 1 dial control to move the text up, since now any changes we make to the Bridge Track dataset now apply to the center of the text that’s connected to it.

The offset we create is shown as a dotted red line that lets us see the actual offset being created by the X and Y Offset controls. In fact, this is why we connected to the Bridge Track: Offset position option earlier.
The text offset from the tracked motion path; the offset can be seen as a dotted red line in the viewer.

Now, if we play through this clip, we can see the text moving along with the bridge.

Two frames of the text being match moved to follow the bridge in the shot.
Chapter 84

Planar Tracking

This chapter provides an overview of how to use the Planar Tracker node, and how to use it to make match moves simple. For more information about the Planar Tracker node, see Chapter 118, “Tracker Nodes” in the DaVinci Resolve Reference Manual or Chapter 57 in the Fusion Reference Manual.

Contents

Introduction to Tracking 1519
Using the Planar Tracker 1519
Different Ways of Using the Planar Tracker Node 1519
Setting Up to Use the Planar Tracker 1520
Check for Lens Distortion 1520
A Basic Planar Tracker Match Move Workflow 1520
Tips for Choosing Good Planes to Track 1523
Introduction to Tracking

Fusion includes three different Tracking nodes that let you analyze different kinds of motion. Once you have tracked motion on a clip, you can then use the resulting data for stabilization, motion smoothing, matching the motion of one object to that of another, and a host of other essential tasks. Each tracker type has its own chapter in this manual. This chapter covers the tracking techniques with the Planar Tracker node.

Using the Planar Tracker

The Planar Tracker node is designed to deal with match moving issues on flat, unvarying surfaces that commonly arise during post-production. Examples of flat, unvarying surfaces include clips containing a license plate, a road sign, or a brick wall that often need images merged on top of them, such as replacing the numbers in the license plate, changing the city’s name in the road sign, or placing a billboard poster on the empty brick wall.

The Planar Tracker automates this process by analyzing the perspective distortions of a planar surface on a background plate over time, and then re-applying those same perspective distortions to a different foreground.

TIP: Part of using the Planar Tracker is also knowing when to give up and fall back to using Fusion’s Tracker node or to manual keyframing. Some shots are simply not trackable, or the resulting track suffers from too much jitter or drift. The Planar Tracker is a time-saving node in the artist’s toolbox and, while it can track most shots, no tracker is a 100% solution.

Different Ways of Using the Planar Tracker Node

Like the other tracking nodes found in Fusion, the Planar Tracker can both analyze and contain the resulting image tracking data interior to the node, and it can also use that tracking data to transform either another image, paint strokes, or a polygon mask shape.

The Planar Tracker provides four modes of operation:

- **Track**: Used to isolate a planar surface and track its movement over time. Then, you can create a Planar Transform node that uses this data to match move another clip in various ways.

- **Steady**: After analyzing a planar surface, this mode removes all motion and distortions from the planar surface, usually in preparation for some kind of paint or roto task, prior to “unsteadying” the clip to add the motion back.

- **Corner Pin**: After analyzing a planar surface, this mode computes and applies a matching perspective distortion to a foreground image you connect to the foreground input of the Planar Tracker node, and merges it on top of the tracked footage.

- **Stabilize**: After analyzing a planar surface, allows smoothing of a clip’s translation, rotation, and scale over time. Good for getting unwanted vibrations out of a clip while retaining the overall camera motion that was intended.
Setting Up to Use the Planar Tracker

Similar to the Tracker node, to do a planar track, you need to connect the output of the image you want to track to the background input of a Planar Tracker node.

![Connecting an image to the background input of a Planar Tracker node](image)

Check for Lens Distortion

If the image has barrel distortion, or any other kinds of lens distortion, it can adversely affect your track. The more lens distortion in the footage, the more the resulting track will slide and wobble. If you can see distortion in the image or you’re having problems with the track, you’ll want to try inserting the Lens Distort node between the image and the Planar Tracker to eliminate this problem.

Fusion’s Lens Distort node can be used to remove or add lens distortion in an image. Connecting the MediaIn or Loader node to the Lens Distort node displays controls for manually correcting lens distortion. If you use Synth Eyes, PFTrack or 3D Equalizer software, you can also import lens data from those applications to make the adjustments more automatic.

![A Lens Distort node inserted between a MediaIn and Planar Tracker to remove lens distortion](image)


If you are using DaVinci Resolve, you can use the Lens Corrections control in the Cut page or Edit page. This adjustment carries over into the Fusion page. Lens correction in DaVinci Resolve automatically analyzes the frame in the Timeline viewer for edges that are being distorted by a wide angle lens. Clicking the Analyze button moves the Distortion slider to provide an automatic correction. From there, the MediaIn node in the Fusion page will have the correction applied, and you can begin planar tracking.

A Basic Planar Tracker

Match Move Workflow

Using the Planar Tracker is a process, but it’s straightforward once you’ve learned how to use it. The following procedure tries to make this process as clear as possible.

To track a surface using the Planar Tracker:

1. Make sure the Operation Mode is set to Track, as you need to analyze an image to track a surface before you do anything else.

2. With the background input of the Planar Tracker connected to an image, and the Planar Tracker open in a viewer, move the playhead to a frame of video where the planar surface you want to track is at its largest, is unoccluded, and is clearly a plane, and then click the Set button in the Track panel of the Inspector to make this the reference frame that will be used to guide the track.
Clicking the Set button to set the reference frame to use for analysis.

3 Next, you’ll need to identify the specific pattern within the image that you want to track. In most cases, this will probably be a rectangle, but any arbitrary closed polygon can be used. The pixels enclosed by this region will serve as the pattern that will be searched for on other frames. Please note that it is important that the pattern is drawn on the reference frame. In this example, we want to track the wall behind the man, so we draw a polygon around part of the wall that the man won’t pass over as he moves during the shot.

Drawing a polygon to identify the part of the image you want to track, which should be a flat, trackable plane.

TIP: Do not confuse the pattern you’re identifying with the region you’re planning to corner pin (which always has four corners and is separately specified in Corner Pin mode).

4 (Optional) If moving objects partially cover up or occlude the planar surface, you may wish to connect a mask that surrounds and identifies these occlusions to the white “occlusion mask” input of the Planar Tracker. This lets the Planar Tracker ignore details that will cause problems.

When using the Hybrid Tracker, providing a mask to deal with occluding objects is nearly mandatory, while with the Point Tracker it is recommended to try tracking without a mask.

5 If necessary, move the playhead back to the reference frame, which in this case was the first frame. Then, click the Track To End button and wait for the track to complete.

The Analyze buttons of the Planar Tracker.

As the clip tracks, you can see track markers and trails (if they’re enabled in the Options tab of the Inspector) that let you see how much detail is contributing to the track, and the direction of motion that’s being analyzed.
During tracking, you can see track markers and trails to follow how well the track is going.

6 Once the track is complete, play through the clip to visually inspect the track so you can evaluate how accurate it is. Does it stick to the surface? Switching to Steady mode can help here, as scrubbing through the clip in Steady mode will help you immediately see unwanted motion in the track.

7 Since we’re doing a match move, click the Create Planar Transform button to export a Planar Transform node that will automatically transform either images or masks to follow the analyzed motion of the plane you tracked.

In this case, the Planar Transform node will be inserted after a pair of Background and Paint nodes that are being used to put some irritatingly trendy tech jargon graffiti on the wall. The Planar Transform will automatically transform the Paint node’s output connected to its background input to match the movement of the wall.
The result is a seamless match move of the fake graffiti married to the wall in the original clip.

The final result; the paint layer is match moved to the background successfully

**TIP:** If you want to composite semi-transparent paint strokes on the wall, or use Apply modes with paint stroke, you can attach a Paint node to a Background node set to 100 transparency. The resulting image will be whatever paint strokes you make against transparency and is easy to composite.

**Tips for Choosing Good Planes to Track**

The region to track is specified by drawing a polygon on the reference frame. Make sure the region selected belongs to a physically planar surface in the shot. Sometimes a region that is only approximately planar can be used. In general, the less planar the surface, the poorer the quality of the resulting track.

As a rule of thumb, the more pixels in the pattern, the better the quality of the track. In particular, this means on the reference frame, the pattern to be tracked should:

- Be as large as possible.
- Be as much in frame as possible.
- Be as unoccluded as possible by any moving foreground objects.
- Be at its maximum size (e.g., when tracking an approaching road sign, it is good to pick a later frame where it is 400 x 200 pixels rather than 80 x 40 pixels).
- Be relatively undistorted (e.g., when the camera orbits around a flat stop sign, it is better to pick a frame where the sign is face on parallel to the camera rather than a frame where it is at a highly oblique angle).

If the pattern contains too few pixels or not enough trackable features, this can cause problems with the resulting track, such as jitter, wobble, and slippage. Sometimes dropping down to a simpler motion type can help in this situation.
Chapter 85

Using Open FX, Resolve FX, and Fuse Plug-Ins

Fusion’s capabilities can be extended using different kinds of plug-ins. All compositions in Fusion Studio and in the Fusion page of DaVinci Resolve support third-party Open FX plug-ins. Additionally, the Fusion page of DaVinci Resolve provides access to all of the Resolve FX that come with DaVinci Resolve.

Lastly, you can develop your own plug-ins without using a computer development environment by scripting Fusion’s native Fuse plug-ins.

Contents

What Are Open FX? 1525
What Are Resolve FX? 1525
Applying Open FX and Resolve FX Plug-Ins 1525
Introduction to Fuse Plug-Ins 1526
What Are Open FX?

Fusion is able to use compatible Open FX (OFX) plug-ins that are installed on your computer. Open FX is an open standard for visual effects plug-ins. It allows plug-ins written to the standard to work on both DaVinci Resolve and Fusion Studio as well as other applications that support the standard.

OFX plug-ins can be purchased and downloaded from third-party suppliers such as BorisFX, Red Giant, and RE:Vision Effects. All OFX appear in the Open FX category of the Effects Library, alongside all other effects that are available in Fusion.

What Are Resolve FX?

The Fusion page is DaVinci Resolve is also able to access Resolve FX. Resolve FX are filter effects within DaVinci Resolve. Although most Resolve FX have the same capabilities on all DaVinci Resolve pages, some are specific to the Color page and require the use of the Color page tracker for full functionality. All Resolve FX appear in the Fusion page Effects Library in the Open FX category alongside third-party OFX plug-ins. Resolve FX are not available in Fusion Studio. For more information about Resolve FX, see Chapter 153, “Resolve FX” in the DaVinci Resolve Reference Manual.

Applying Open FX and Resolve FX Plug-Ins

Resolve FX and OFX plug-ins are applied to the Node Editor just as you would apply native Fusion nodes. They can help you create fast, interesting looks and effects using the Color page, or imaginative transitions and effects on your clips on the Edit page. Resolve FX are installed with DaVinci Resolve.

After installing a set of OFX plug-ins, you can access them or Resolve FX plug-ins in Fusion by opening the Open FX category in the Effects Library.

To add a plug-in to the Node Editor, either click the Open FX or Resolve FX plug-in name in the Effects Library or drag and drop the plug-in onto a connection line to insert it into the node tree. If the plug-in has editable settings, you can adjust these in the Inspector.
Introduction to Fuse Plug-Ins

Fuses are plug-ins developed for Fusion using the Lua built-in scripting language. Being script-based, Fuses are compiled on-the-fly in Fusion without the need of a computer programming environment. While a Fuse may be slower than an identical Open FX plug-in created using Fusion’s C++ SDK, a Fuse will still take advantage of Fusion’s existing nodes and GPU acceleration.

To install a Fuse:

1. Use the .fuse extension at the end of the document name.
2. For DaVinci Resolve, save it in one of the following locations:
   - On macOS: Macintosh HD/Users/username/Library/Application Support/Blackmagic Design/DaVinci Resolve/Fusion/Fuses
   - On Windows: C:\Users\username\AppData\Roaming\Blackmagic Design\DaVinci Resolve\Support\Fusion\Fuses
   - On Linux: home/username/..local/share/DaVinciResolve/Fusion/Fuses

For Fusion Studio, save it in one of the following locations:

- On macOS: Macintosh HD/Users/username/Library/Application Support/Blackmagic Design/Fusion/Fuses/
- On Windows: C:\Users\username\AppData\Roaming\Blackmagic Design\Fusion\Fuses
- On Linux: home/username/fusion/BlackmagicDesign/Fusion/Fuses

You can open and edit Fuses by selecting the Fuse node in the Node Editor and clicking the Edit button at the top of the Inspector. The Fuse opens in the text editor specified in the Global Preferences/Scripting panel.

TIP: Changes made to a Fuse in a text editor do not immediately propagate to other instances of that Fuse in the composition. Reopening a composition updates all Fuses in the composition based on the current saved version. Alternatively, you can click the Reload button in the Inspector to update the selected node without closing and reopening the composition.
Chapter 86

3D Compositing Basics

This chapter covers many of the nodes used for creating 3D composites, the tasks they perform, and how they can be combined to produce effective 3D scenes.

Contents

- An Overview of 3D Compositing 1528
- 3D Compositing Fundamentals 1529
- Creating a Minimal 3D Scene 1530
- The Elements of a 3D Scene 1531
- Geometry Nodes 1531
- The Merge3D Node 1533
- The Renderer3D Node 1536
- Software vs. GPU Rendering 1536
- Software Renderer 1536
- OpenGL Renderer 1537
- OpenGL UV Renderer 1537
- Loading 3D Nodes into the Viewer 1538
- Navigating the 3D View 1540
- Transforming Cameras and Lights Using the Viewers 1540
- Transparency Sorting 1541
- Material Viewer 1542
- Transformations 1543
- Onscreen Transform Controls 1543
- Pivot 1544
- Target 1544
- Parenting 1546
An Overview of 3D Compositing

Traditional image-based compositing is a two-dimensional process. Image layers have only the amount of depth needed to define one as foreground and another as background. This is at odds with the realities of production, since all images are either captured using a live-action camera with freedom in all three dimensions, in a shot that has real depth, or have been created in a true 3D modeling and rendering application.

Within the Fusion Node Editor, you have a GPU-accelerated 3D compositing environment that includes support for imported geometry, point clouds, and particle systems for taking care of such things as:

- Converting 2D images into image planes in 3D space
- Creating rough primitive geometry
- Importing mesh geometry from FBX or Alembic scenes
- Creating realistic surfaces using illumination models and shader compositing
- Rendering with realistic depth of field, motion blur, and supersampling
Creating and using 3D particle systems
Creating, extruding, and beveling 3D text
Lighting and casting shadows across geometry
3D camera tracking
Importing cameras, lights, and materials from 3D applications such as Maya, 3ds Max, or LightWave
Importing matched cameras and point clouds from applications such as SynthEyes or PF Track

3D Compositing Fundamentals

The 3D category of nodes (which includes the Light, Material, and Texture subcategories) work together to create 3D scenes. Examples are nodes that generate geometry, import geometry, modify geometry, create lights and cameras, and combine all these elements into a scene. Nearly all these nodes are collected within the 3D category of nodes found in the Effects Library.

Conveniently, at no point are you required to specify whether your overall composition is 2D or 3D, because you can seamlessly combine any number of 2D and 3D “scenes” together to create a single output. However, the nodes that create these scenes must be combined in specific ways for this to work properly.
Creating a Minimal 3D Scene

Creating a 3D scene couldn’t be easier, but you need to connect the required nodes in the right way. At minimum, you need only connect a geometry node (such as a Text3D node) to a Renderer3D node to output a 2D image that can be combined with other 2D images in your composition, as seen below. However, you’ll only get a simply shaded piece of geometry for your trouble, although you can color and transform it in the Inspector using controls internal to whichever geometry node you’re using.

![A simple 3D scene with a Text3D node connected directly to a Renderer3D node](image)

More realistically, each 3D scene that you want to create will probably have three to five nodes to give you a better lit and framed result. These include:

- One of the available geometry nodes (such as Text3D or Image Plane 3D)
- A light node (such as DirectionalLight or SpotLight)
- A camera node
- A Merge3D node
- A Renderer3D node

All these should be connected together as seen below, with the resultantly more complex 3D scene shown below.

![The same text, this time lit and framed using Text3D, Camera, and SpotLight nodes to a Merge3D node](image)
To briefly explain how this node tree works, the geometry node (in this case Text3D) creates an object for the scene, and then the Merge3D node provides a virtual stage that combines the attached geometry with the light and camera nodes to produce a lit and framed result with highlights and shadows, while the aptly named Renderer3D node renders the resulting 3D scene to produce 2D image output that can then be merged with other 2D images in your composition.

In fact, these nodes are so important that they appear at the right of the toolbar, enabling you to quickly produce 3D scenes whenever you require. You might notice that the order of the 3D buttons on the toolbar, from left to right, corresponds to the order in which these nodes are ordinarily used. So, if you simply click on each one of these buttons from left to right, you cannot fail to create a properly assembled 3D scene, ready to work on, as seen in the previous screenshot.

The 3D nodes available from the toolbar include the ImagePlane3D, Shape3D, Text3D, Merge3D, Camera3D, SpotLight3D, and Renderer3D nodes.

The Elements of a 3D Scene

All 3D nodes can be divided into a number of categories.

Geometry Nodes

You can add 3D geometry to a composition using the ImagePlane3D node, the Shape3D node, the Cube3D node, the Text3D node, or optionally by importing a model via the FBX Mesh 3D node. Furthermore, you can add particle geometry to scenes from pEmitter nodes. You can connect these to a Merge3D node either singularly or in multiples to create sophisticated results combining multiple elements.

Texturing Geometry

By itself, geometry nodes can only consist of a simple flat color. However, you can alter the look of 3D geometry by texturing it using clips (either still images or movies), using material nodes such as the...
Blinn and Phong nodes to create more sophisticated textures with combinations of 2D images and environment maps, or you can use a preset shader from the Templates > Shader bin of the Effects Library, which contains materials and texture presets that are ready to use.

If you’re working with simple geometric primitives, you can texture them by connecting either an image (a still image or movie) or a shader from the Templates bin of the Effects Library directly to the material input of a Shape3D, Cube3D, or other compatible node, as shown below.

An image connected to the material input of a Shape3D node set to Taurus, with the image (left), and the shaded taurus (right)

If you’re shading or texturing Text3D nodes, you need to add a texture in a specific way since each node is actually a scene with individual 3D objects (the characters) working together. In the following example, the RustyMetal shader preset is applied to a Text3D node using the ReplaceMaterial3D node. The interesting thing about the ReplaceMaterial3D node is that it textures every geometric object within a scene at once, meaning that if you put a ReplaceMaterial3D node after a Text3D node, you texture every character within that node. However, if you place a ReplaceMaterial3D node after a Merge3D node, then you’ll end up changing the texture of every single geometric object being combined within that Merge3D node, which is quite powerful.

The geometry created by a Text3D node is textured using a shader connected to a ReplaceMaterial3D node that’s connected downstream of the object you want to shade
The Merge3D Node

The Merge3D node combines the output of one or more 3D nodes into a single scene. Unlike the Merge2D node, the ordering of elements in the scene is not restricted to only background and foreground inputs. Instead, the Merge3D node lets you connect an unlimited number of inputs, with the resulting output combined according to each object’s absolute position in 3D space.

Combining Objects Directly

While the Merge3D node provides a structured way of combining objects, you can also combine 3D objects such as Text3D and Shape3D nodes by connecting the output of one 3D object node to the input of another, as seen in the following screenshot. When you do this, you must use each node’s internal transform parameters to transform their position, size, and rotation directly, but the transform control of downstream 3D object nodes also transforms all upstream 3D object nodes. This even works for lights and the Camera3D node, giving you a fast way of combining a set of objects that always go together, which you can later connect to a Merge3D node for additional lighting and eventual connection to a Renderer3D node.
Combining Multiple Merge3D Nodes

Furthermore, Merge3D nodes can be combined with other Merge3D nodes, allowing you to create composite 3D scenes made up of multiple “sub-scenes,” each put together within individual Merge3D nodes.

You can build elaborate scenes using multiple Merge3D nodes connected together

Lighting Multiple Merge3D Nodes

Once you’ve combined multiple Merge3D nodes, there’s an easy way to control how lights that are connected to upstream Merge3D nodes affect the results of other Merge3D nodes connected downstream. Each Merge3D node’s Controls tab contains a single checkbox, Pass Through Lights, which enables lighting to pass through the output of an upstream Merge3D node in order to shine onto objects connected to downstream Merge3D nodes.

You can light downstream Merge3D scenes with lights connected to upstream Merge3D scenes by turning on Pass Through Lights

This checkbox is disabled by default, which lets you light elements in one Merge3D scene without worrying about how the lighting will affect geometry attached to other Merge3D nodes further downstream. For example, you may want to apply a spotlight to brighten the wall of a building in one Merge3D node without having that spotlight spill over onto the grass or pavement at the foot of the wall modeled in another Merge3D node. In the example shown below, the left image shows how the cone and taurus connected to a downstream node remain unlit by the light in an upstream node with Pass Through Lights disabled, while the right image shows how everything becomes lit when turning Pass Through Lights on.

The result of lights on the text in one Merge3D node not affecting the cone and taurus added in a downstream Merge3D node (left) Turning on Pass Through Lights in the upstream Merge3D node results in those lights also illuminating the downstream shapes (right)
Transforming Merge3D Scenes

Each Merge3D node includes a Transform tab. These transform parameters adjust the position, scale, and rotation of all objects being combined within that Merge3D node together, including lighting and particles. All transformations take place around a common pivot point. This forms the basis of parenting in the 3D environment.

If you transform a Merge3D node that’s connected to other Merge3D nodes, what happens depends on which node you’re transforming, an upstream node or the downstream node:

– If you transform a downstream Merge3D node, you also transform all upstream nodes connected to it as if they were all a single scene.

– If you transform an upstream Merge3D node, this has no effect on downstream Merge3D nodes, allowing you to make transforms specific to that particular node’s scene.

Transforming Upstream, Lighting Downstream

When building complex scenes using multiple Merge3D nodes being combined together, it’s common to use one last downstream node to combine light and camera nodes to illuminate the final scene, while leaving the upstream Merge3D nodes free for controlling object transforms and animation. This way, you can transform and animate subsets of your overall scene without worrying about accidentally altering the overall lighting scheme or cameras for that scene, unless you’ve specifically connected lights or cameras upstream that are meant to be attached to the geometry you’re transforming.
The Renderer3D Node

Every 3D node you add outputs a complete 3D scene. This is unlike most traditional 3D modeling and animation programs, where all objects reside within a global scene environment. This means that the scenes created by a Camera 3D node and an image plane are separate until they’re combined into the same scene via a Merge3D node, which itself outputs a complete 3D scene. However, this 3D scene data can neither be composited with other 2D images in your composition nor rendered out without first being rendered within the node tree using a Renderer3D node.

To be more specific, 3D nodes that output 3D scenes cannot be connected directly to inputs that require 2D images. For example, the output of an ImagePlane3D node cannot be connected directly to the input of a Blur node, nor can the output of a Merge3D node be directly connected to a regular Merge node. First, a Renderer3D node must be placed at the end of your 3D scene to render it into 2D images, which may then be composited and adjusted like any other 2D image in your composition.

Output of a Merge3D connected to a Renderer3D node to output 2D image data

The Renderer3D uses one of the cameras in the scene (typically connected to a Merge3D node) to produce an image. If no camera is found, a default perspective view is used. Since this default view rarely provides a useful angle, most people build 3D scenes that include at least one camera.

The image produced by the Renderer3D can be any resolution with options for fields processing, color depth, and pixel aspect.

Software vs. GPU Rendering

The Renderer3D node lets you choose between using a software renderer or an OpenGL renderer, trading off certain aspects of rendered image quality for speed, and trading off depth of field rendering for soft shadow rendering, depending on the needs of a particular element of your composition. To choose which method of rendering to use, there’s a Renderer Type pop-up menu in the Controls tab of each Renderer3D node’s parameters in the Inspector. The default is Software Renderer.

Software Renderer

The software renderer is generally used to produce the final output. While the software renderer is not the fastest method of rendering, it has twin advantages. First, the software renderer can easily handle textures much larger than one half of your GPU’s maximum texture size, so if you’re working with texture images larger than 8K you should choose the software renderer to obtain maximum quality.
Second, the software renderer is required to enable the rendering of “constant” and “variable” soft shadows with adjustable Spread, which is not supported by the OpenGL renderer. Soft shadows are more natural, and they’re enabled in the Shadows parameters of the Controls tab of light nodes; you can choose Sampling Quality and Softness type, and adjust Spread, Min Softness, and Filter Size sliders. Additionally, the software renderer supports alpha channels in shadow maps, allowing transparency to alter shadow density.

When the Renderer3D node “Renderer Type” drop-down is set to OpenGL Renderer, you cannot render soft shadows or excessively large textures (left). When the Renderer3D node “Renderer Type” drop-down is set to Software Renderer, you can render higher-quality textures and soft shadows (right).

**OpenGL Renderer**

The OpenGL renderer takes advantage of the GPU in your computer to render the image; the textures and geometry are uploaded to the graphics hardware, and OpenGL shaders are used to produce the result. This can produce high-quality images that can be perfect for final rendering, and can also be potentially orders of magnitude faster than the software renderer, but it does pose some limitations on some rendering effects, as soft shadows cannot be rendered, and the OpenGL renderer also ignores alpha channels during shadow rendering, resulting in a shadow always being cast from the entire object.

On the other hand, because of its speed, the OpenGL renderer exposes additional controls for Accumulation Effects that let you enable depth of field rendering for creating shallow-focus effects. Unfortunately, you can’t have both soft shadow rendering and depth of field rendering, so you’ll need to choose which is more important for any given 3D scene you render.

**Don’t Forget That You Can Combine Rendered Scenes in 2D**

While it may seem like an insurmountable limitation that you can’t output both soft shadows and depth of field using the same renderer, don’t forget that you can create multiple 3D scenes each using different renderers and composite them in 2D later on. Furthermore, you can also render out auxiliary channels that can be used by 2D image processing nodes such as AmbientOcclusion, DepthBlur, and Fog to create pseudo-3D effects using the rendered images.

**OpenGL UV Renderer**

When you choose the OpenGL UV Renderer option, a Renderer3D node outputs an “unwrapped” version of the textures applied to upstream objects, at the resolution specified within the Image tab of that Renderer3D node.
This specially output image is used for baking out texture projections or materials to a texture map for one of two reasons:

- **Baking out projections can speed up a render.**
- **Baking out projections lets you modify the texture using other 2D nodes within your composition, or even using third-party paint applications (if you output this image in isolation as a graphics file) prior to applying it back onto the geometry.**

Suppose, for instance, that you have a scene on a street corner, and there’s a shop sign with a phone number on it, but you want to change the numbers. If you track the scene and have standing geometry for the sign, you can project the footage onto it, do a UV render, switch the numbers around with a Paint node, and then apply that back to the mesh with a Texture2D.

The UV renderer can also be used for retouching textures. You can combine multiple DSLR still shots of a location, project all those onto the mesh, UV render it out, and then retouch the seams and apply it back to the mesh.

You could project tracked footage of a road with cars on it, UV render out the projection from the geometry, do a temporal median filter on the frames, and then map a “clean” roadway back down.

### Loading 3D Nodes into the Viewer

When you load a 3D node into the viewer, it switches to a 3D Viewer, which lets you pan, zoom, and rotate the scene in 3D, making it easy to make adjustments in three dimensions.
The interactive 3D Viewer is highly dependent on the computer’s graphics hardware, relying on support from OpenGL. The amount of onboard memory, as well as the speed and features of your workstation’s GPU, make a huge difference in the speed and capabilities of the 3D Viewer.

Displaying a node with a 3D output in any viewer will switch the display type to a 3D Viewer. Initially, the contents of the scene will be displayed through a default perspective view.

A 3D Viewer’s default perspective view

To change the viewpoint, right-click in the viewer and choose the desired viewpoint from the ones listed in the Camera submenu. A shortcut to the Camera submenu is to right-click on the axis label displayed in the bottom corner of the viewer.

Right-click the Axis label of the viewer to change the viewpoint

In addition to the usual Perspective, Front, Top, Left, and Right viewpoints, if there are cameras and lights present in the scene as potential viewpoints, those are shown as well. It’s even possible to display the scene from the viewpoint of a Merge3D or Transform3D by selecting it from the contextual menu’s Camera > Other submenu. Being able to move around the scene and see it from different viewpoints can help with the positioning, alignment, and lighting, as well as other aspects of your composite.
Navigating the 3D View

For the most part, panning and scaling of the 3D Viewer uses the same controls as the 2D Viewer. For more information about the options available in the 3D Viewer, see Chapter 68, “Using Viewers” in the DaVinci Resolve Reference Manual or Chapter 7 in the Fusion Reference Manual.

To pan in a 3D Viewer, do the following:
- Hold the middle mouse button and drag in the viewer.

To dolly (zoom) in the 3D Viewer, do one of the following:
- Hold down the middle and left mouse buttons and drag left or right in the viewer.
- Hold down the Command key and use your pointing device’s scroll control.

To rotate around the 3D Viewer, do the following:
- Hold down the Option key and middle-button-drag left and right in the viewer.

If you want to frame certain objects in the viewer:
1. Select the viewer you want to work in.
2. Do one of the following:
   - Press Shift-F to Fit all objects in the viewer.
   - Press F to Fit to selection (or Fit All if nothing is selected).
   - Press D to Rotate the viewer to look at the center of the currently selected object without moving the viewer’s position.

Furthermore, selecting a 3D node in the Node Editor also selects the associated object in the 3D Viewer.

Transforming Cameras and Lights Using the Viewers

When the viewer is set to look through a 3D object in the scene, such as a camera or spotlight, the usual controls for panning and rotating the viewer will now directly affect the position of the camera or spotlight you’re viewing through. Here’s an example.

To adjust a camera’s position when looking through it in a viewer:
1. Right-click the viewpoint label, and choose a camera from the contextual menu. (Optional) If you’re in dual-viewer mode, you can load the camera you’ve selected in one viewer into the other viewer to see its position as you work.
2. Move the pointer into the viewer that’s displaying the camera’s viewpoint.
Hold the middle and left mouse buttons down and drag to zoom the viewer, or middle-click-drag to pan the viewer, or option-middle-click-drag to rotate the viewer, all while also moving the camera.

When a viewer is set to display the view of a camera or light, panning, zooming, or rotating the viewer (seen at right) actually transforms the camera or light you’re viewing through (seen at left).

It is even possible to view the scene from the perspective of a Merge3D or Transform3D node by selecting the object from the Camera > Others menu. The same transform techniques will then move the position of the object. This can be helpful when you are trying to orient an object in a certain direction.

**Transparency Sorting**

While generally the order of geometry in a 3D scene is determined by the Z-position of each object, sorting every face of every object in a large scene can take an enormous amount of time. To provide the best possible performance, a Fast Sorting mode is used in the OpenGL renderer and viewers. This is set by right-clicking in the viewer and choosing Transparency > Z-buffer. While this approach is much faster than a full sort, when objects in the scene are partially transparent it can also produce incorrect results.

The Sorted (Accurate) mode can be used to perform a more accurate sort at the expense of performance. This mode is selected from the Transparency menu of the viewer’s contextual menu. The Renderer3D also presents a Transparency menu when the Renderer Type is set to OpenGL. Sorted mode does not support shadows in OpenGL. The software renderer always uses the Sorted (Accurate) method.
The basic rule is when a scene contains overlapping transparency, use the Full/Quick Sort modes, and otherwise use the Z-buffer (Fast). If the Full Sort method is too slow, try switching back to Z-buffer (Fast).

**Material Viewer**

When you view a node that comes from the 3D > Material category of nodes in the Effects Library, the viewer automatically switches to display a Material Viewer. This Material Viewer allows you to preview the material applied to a lit 3D sphere rendered with OpenGL by default.

The Material Viewer mode of the viewer

The type of geometry, the renderer, and the state of the lighting can all be set by right-clicking the viewer and choosing options from the contextual menu. Each viewer supports A and B buffers to assist with comparing multiple materials.

**Methods of working with the Material Viewer:**

- You can change the shape of the previewed geometry by right-clicking the viewer and choosing an option from the Shape submenu of the contextual menu. The geometry that the material is applied to is locked to the center of the viewer and scaled to fit. It is not possible to pan or scale the Material Viewer.

- The Material Viewer can be rotated to provide a different angle on the material by holding Option while pressing the middle mouse button and dragging to the left and right.

- You can adjust the position of the light used to preview the material by dragging with the middle mouse button. Or, you can right-click the viewer and choose an option from the Lighting > Light Position submenu of the contextual menu.

- You can also toggle lighting off and on by right-clicking the viewer and choosing Lighting > Enable Lighting from the contextual menu.

- You can choose the renderer used to preview the material by right-clicking the viewer and choosing an option from the Renderer submenu of the contextual menu.
Transformations

Merge3D, 3D Objects, and Transform3D all have Transform parameters that are collected together into a Transform tab in the Inspector. The parameters found in this tab affect how the object is positioned, rotated, and scaled within the scene.

The Transform tab of a Merge3D node

The Translation parameters are used to position the object in local space, the Rotation parameters affect the object’s rotation around its own center, and the Scale slider(s) affect its size (depending on whether or not they’re locked together). The same adjustments can be made in the viewer using onscreen controls.

Onscreen Transform Controls

When an object is selected, it displays onscreen Transform controls in the viewers that allow you to adjust the object’s position, rotation, and scale. Buttons in the Transform toolbar allow you to switch modes, or you can use the keyboard shortcuts.

To switch Transform modes, use the following keyboard shortcuts:

– Press Q for Position
– Press W for Rotation
– Press E for Scaling

Using Onscreen Transform Controls

In all three modes, red indicates the object’s local X-axis, green the Y-axis, and blue the Z-axis, respectively (just remember RGB = XYZ). You can drag directly on the red, green, or blue portion of any onscreen control to constrain the transform to that axis, or if you drag the center of the onscreen control, you can apply a transform without constraints. Holding Option and dragging in the viewer allows you to freely translate in all three axes without clicking on a specific control.
If the Scale’s Lock XYZ checkbox is enabled in the Inspector, only the overall scale of the object is adjusted by dragging the red or center onscreen control, while the green and blue portions of the onscreen control have no effect. If you unlock the parameters, you are able to scale an object along individual axes separately to squash or stretch the object.

**Selecting Objects**

With the onscreen controls visible in the viewer, you can select any object by clicking on its center control. Alternatively, you can also select any 3D object by clicking its node in the Node Editor.

**Pivot**

In 3D scenes, objects rotate and scale around an axis called a pivot. By default, this pivot goes through the object’s center. If you want to move the pivot so it is offset from the center of the object, you can use the X, Y, and Z Pivot parameters in the Inspector.

**Target**

Targets are used to help orient a 3D object to a specific point in the scene. No matter where the object moves, it will rotate in the local coordinate system so that it always faces its target, which you can position and animate.

**To enable a target for a 3D object:**

1. Select that object’s node.
2. Open the object’s Transform panel in the Inspector.
3. Turn on the Use Target checkbox.
4. Use the X/Y/Z Target Position controls in the Inspector or the Target onscreen control in the viewer to position the target and in turn position the object it’s attached to.
In the viewer, a line is drawn between the target and the center of the 3D object it’s attached to, to show the relationship between these two sets of controls. Whenever you move the target, the object is automatically transformed to face its new position.

For example, if a spotlight is required in the scene to point at an image plane, enable the spotlight’s target in the Transform tab and connect the target’s XYZ position to the image plane’s XYZ position. Now, no matter where the spotlight is moved, it will rotate to face the image plane.
Parenting

One of the many advantages of the node-based approach to 3D compositing is that parenting between objects becomes implicit in the structure of a 3D node tree. The basis for all parenting is the Merge3D node. If you’re careful about how you connect the different 3D objects you create for your scene, you can use multiple Merge3D nodes to control which combinations of objects are transformed and animated together, and which are transformed and animated separately.

For example, picture a scene with two spheres that are both connected to a Merge3D. The Merge3D can be used to rotate one sphere around the other, like the moon around the earth. Then the Merge3D can be connected to another Merge3D to create the earth and the moon orbiting around the sun.

Here are the two simple rules of transforming parented Merge3D nodes:

1. Transforms and animation applied to a Merge3D are also applied to all 3D objects connected to that Merge3D node, including cameras, lights, geometry, and other merge nodes connected upstream.
2. Transforms and animation applied to upstream merge nodes don’t affect downstream merge nodes.

Cameras

When setting up and animating a 3D scene, the metaphor of a camera is one of the most comprehensible ways of framing how you want that scene to be rendered out, as well as animating your way through the scene. Additionally, compositing artists are frequently tasked with matching cameras from live-action clips, or matching cameras from 3D applications.

To accommodate all these tasks, Fusion provides a flexible Camera3D node with common camera controls such as Angle of View, Focal Length, Aperture, and Clipping planes, to either set up your own camera or to import camera data from other applications. The Camera3D node is a virtual camera through which the 3D environment can be viewed.
A camera displayed with onscreen Transform controls in the viewer; the Focal Plane indicator is enabled in green.

Cameras are typically connected and viewed via a Merge3D node; however, you can also connect cameras upstream of other 3D objects if you want that camera to transform along with that object when it moves.

Quickly Viewing a Scene Through a Camera

When you’ve added a camera to a scene, you can quickly view the scene “through the camera” by setting up the following.

To view the scene through the camera:
1. Select the Merge3D node that the camera is connected to, or any node downstream of that Merge3D.
2. Load the selected Merge3D or downstream node into a viewer.
3. Right-click on the axis label in the bottom corner of the viewer and choose the camera name.

The viewer’s frame may be different from the camera frame, so it may not match the true boundaries of the image that will be rendered by the Renderer3D node. If there is no Renderer3D node added to your scene yet, you can use Guides that represent the camera’s framing. For more information about Guides, see Chapter 68, “Using Viewers” in the DaVinci Resolve Reference Manual or Chapter 7 in the Fusion Reference Manual.

Plane of Focus and Depth of Field

Cameras have a plane of focus, for when depth of field rendering is available. Here’s the procedure for enabling depth of field rendering in your scenes.

To render depth of field in a 3D scene:
1. You must add a Renderer3D node at the end of your 3D scene.
2. Select the Renderer3D node, and set the Renderer Type to OpenGL Renderer.
3. Open the Accumulation Effects disclosure control that appears, and turn on the Enable Accumulation Effects checkbox in the OpenGL render.

Turning on “Enable Accumulation Effects” exposes a Depth of Field checkbox along with Quality and Amount of DoF Blur sliders that let you adjust the depth of field effect. These controls affect only the perceived quality of the depth of field that is rendered. The actual depth of field that’s generated depends solely on the setup of the camera and its position relative to the other 3D objects in your scene.

When you select your scene’s Camera3D node to view its controls in the Inspector, a new Focal Plane checkbox appears in the Control Visibility group. Turning this on lets you see the green focal plane indicator in the 3D Viewer that lets you visualize the effect of the Focal Plane slider, which is located in the top group of parameters in the Camera3D node’s Controls tab.

For more information about these specific camera controls, see Chapter 90, “3D Nodes” in the DaVinci Resolve Reference Manual, or Chapter 29 in the Fusion Reference Manual.

**Importing Cameras**

If you want to match cameras between applications, you can import camera paths and positions from a variety of popular 3D applications. Fusion is able to import animation splines from Maya and XSI directly with their own native spline formats. Animation applied to cameras from 3ds Max and LightWave are sampled and keyframed on each frame.

**To import a camera from another application, do the following:**

1. Select the camera in the Node Editor.
2. At the bottom of the Inspector, click the Import Camera button.
3. In the file browser, navigate to and select the scene that contains the camera you want to import.
A dialog box with several options will appear. When the Force Sampling checkbox is enabled, Fusion will sample each frame of the motion, regardless of the format.

The Select Camera dialog

**TIP:** When importing parented or rigged cameras, baking the camera animation in the 3D application before importing it into Fusion often produces more reliable results.

---

**Lighting and Shadows**

You can add light sources to a scene to create very detailed lighting environments and atmosphere. There are four different types of lights you can use in 3D scenes: ambient, directional, point, and spotlights.

**Enabling Lighting in the Viewer**

A scene without lights uses a default directional light, but this automatically disappears once you add a 3D light object. However, even when you add light objects to your scene, lighting and shadows won’t be visible in the viewer unless you first enable lighting in the viewer contextual menu by right-clicking anywhere within a viewer and choosing 3D Options > Lighting or Shadows to turn on one or both.

**Enabling Lighting to Be Rendered**

Lighting effects won’t be rendered in the Renderer3D node until the Enable Lighting and/or Shadows checkboxes are checked in the Inspector.

The Lighting button under the viewer

**NOTE:** When lighting is disabled in either the viewer or final renders, the image will appear to be lit by a 100% ambient light.
**Cotrolling Lighting within Each 3D Object**

All nodes that create or merge geometry also include lighting options that are used to choose how each object is affected by light:

- Merge3D nodes have a Pass Through Lights checkbox that determines whether lights attached to an upstream Merge3D node also illuminate objects attached to downstream Merge3D nodes.
- ImagePlane3D, Cube3D, Shape3D, Text3D, and FBXMesh3D nodes have a set of Lighting controls that let you turn three controls on and off: Affected by Lights, Shadow Caster, and Shadow Receiver.

![Lighting controls](image)

3D objects have individual lighting controls that let you control how each object interacts with light and shadows

**Lighting Types Explained**

Here's a more detailed explanation of each type of light in Fusion.

**Ambient Light**

You use ambient light to set a base light level for the scene, since it produces a general uniform illumination of the scene. Ambient light exists everywhere without appearing to come from any particular source; it cannot cast shadows and will tend to fill in shadowed areas of a scene.

**Directional Light**

A directional light is composed of parallel rays that light up the entire scene from one direction, creating a wall of light. The sun is an excellent example of a directional light source.

**Point Light**

A point light is a well defined light that has a small clear source, like a light bulb, and shines from that point in all directions.

**Spotlight**

A spotlight is an advanced point light that produces a well defined cone of light with falloff. This is the only light that produces shadows.

![Light types](image)

From left to right: Directional light, point light, and spotlight
All of the Light nodes display onscreen controls in the viewer, although not all controls affect every light type. In the case of the ambient light, the position has no effect on the results. The directional light can be rotated, but position and scale will be ignored. The point light ignores rotation. Both position and rotation apply to the spotlight.

Lighting Hierarchies
Lights normally do not pass through a Merge, since the Pass Through Lights checkbox is off by default. This provides a mechanism for controlling which objects are lit by which lights. For example, in the following two node trees, two shapes and an ambient light are combined with a Merge3D node, which is then connected to another Merge3D node that’s also connected to a plane and a spotlight. At the left, the first Merge3D node of this tree has Pass Through Lights disabled, so you can only see the two shapes lit. At the right, Pass Through Lights has been enabled, so both the foreground shapes and the background image plane receive lighting.

Pass Through Lights is disabled, so only the front two shapes are illuminated (left) Pass Through Lights is enabled, so all shapes connected to both Merge3D nodes are illuminated (right)

Lighting Options
Most nodes that generate geometry have additional options for lighting. These options are used to determine how each individual object reacts to lights and shadows in the scene.

- **Affected By Lights**: If the Affected By Lights checkbox is enabled, lights in the scene will affect the geometry.
- **Shadow Caster**: When enabled, the object will cast shadows on other objects in the scene.
- **Shadow Receiver**: If this checkbox is enabled, the object will receive shadows.
Shadows

The only light that can cast shadows is the spotlight. Spotlight nodes cast shadows by default, although these shadows will not be visible in the viewer until shadows are enabled using the viewer toolbar button. Shadows will not appear in the output of the Renderer3D unless the Shadows option is enabled for that renderer. If you want to prevent a spotlight from casting shadows, you can disable the Enable Shadows checkbox in the node’s Inspector.

An image with spotlight casting a variable soft shadow

For more information on shadow controls, see the “Spotlight” section of Chapter 91, “3D Light Nodes” in the DaVinci Resolve Reference Manual or Chapter 30 in the Fusion Reference Manual.

Shadow Maps

A shadow map is an internal depth map that specifies each pixel’s depth in the scene. This information is used to assemble the shadow layer created from a spotlight. All the controls for the shadow map are found in the Spotlight Inspector.

The quality of the shadow produced depends greatly on the size of the shadow map. Larger maps generate better-looking shadows but will take longer to render. The wider the cone of the spotlight, or the more falloff in the cone, the larger the shadow map will need to be to produce useful quality results. Setting the value of the Shadow Map Size control sets the size of the depth map in pixels.

Generally, through trial and error, you’ll find a point of diminishing returns where increasing the size of the shadow map no longer improves the quality of the shadow. It is not recommended to set the size of the shadow maps any larger than they need to be.

The Shadow Map Proxy control is used to set a percentage by which the shadow map is scaled for fast interactive previews, such as Autoproxy and LoQ renders. A value of .4, for example, represents a 40% proxy.

Shadow Softness

By default, the spotlight generates shadows without soft edges, but there are options for constant and variable soft shadows. Hard-edged shadows will render significantly faster than either of the Soft Shadow options. Shadows without softness will generally appear aliased, unless the shadow map size is large enough. In many cases, softness is used to hide the aliasing rather than increasing the shadow map to preserve memory and avoid exceeding the graphics hardware capabilities.

Soft Shadow controls in the Control panel

Setting the spotlight’s shadow softness to None will render crisp and well-defined shadows. The Constant option will generate shadows where the softness is uniform across the shadow.
regardless of the shadow’s distance from the casting geometry. The Variable option generates shadows that become softer as they get farther from the geometry that is casting the shadow. This is a more realistic effect, but the shadows are somewhat harder to control. When this option is selected, additional controls for adjusting the falloff of the shadow will appear, as well as sliders for the minimum and maximum softness.

Selecting the Variable option reveals the Spread, Min Softness, and Filter Size sliders. A side effect of the method used to produce variable softness shadows is that the size of the blur applied to the shadow map can become effectively infinite as the shadow’s distance from the geometry increases. These controls are used to limit the shadow map by clipping the softness calculation to a reasonable limit.

The filter size determines where this limit is applied. Increasing the filter size increases the maximum possible softness of the shadow. Making this smaller can reduce render times but may also limit the softness of the shadow or potentially even clip it. The value is a percentage of the shadow map size.


**Multiplicative and Additive Bias**

Shadows are essentially textures applied to objects in the scene that occasionally result in “fighting.” Z-fighting results when portions of an object that should be receiving shadows instead render over the top of the shadow because they effectively exist in the same exact location in 3D space.
Two Biasing sliders in the Shadows group of Spotlight parameters work by adding a small depth offset to move the shadow away from the surface it is shadowing, eliminating the Z-fighting. When too little bias is added, the objects can self shadow themselves. When too much is added, the shadow can become separated from the surface.

The goal is to adjust the Multiplicative Bias slider until the majority of the Z-fighting is resolved, and then adjust the Additive Bias slider to eliminate the rest. The softer the shadow, the higher the bias will probably have to be. You may even need to animate the bias to get a proper result for some particularly troublesome frames.

**Force All Materials Non-Transmissive**

How light passes through a semi-transparent material plays an important role in determining the appearance of the shadow an object casts. Normally, this transmittance behavior is defined in each object’s Materials tab. However, selecting Force All Materials Non-Transmissive in the Spotlight Inspector overrides this, causing the shadow map produced by the node to ignore transmittance entirely.

**Materials and Textures**

To render a 3D scene, the renderer must take into account the shape of the object as well as its appearance. The geometry of an object defines the shape of the object, while the material applied to the object defines its appearance. Fusion provides a range of options for applying materials and textures to geometry, so you can give your 3D objects the surface qualities you want.

Nodes that describe the geometry’s response to light are called illumination models. Blinn, Cook-Torrance, Ward, and Phong are the included illumination models. These nodes are found in the 3D > Material category of nodes in the Effects Library.

Most materials also accept textures, which are typically 2D images. Textures are used to refine the look of an object further, by adding photorealistic details, transparency, or special effects. More complex textures like bump maps, 3D textures, and reflection maps are also available in the 3D > Texture category.

Materials can also be combined to produce elaborate and highly detailed composite materials. Each node that creates or loads geometry into a 3D scene also assigns a default material. The default material is the Blinn illumination model, but you can override this material using one of several nodes that output a 3D material. Some of these materials provide a greater degree of control over how the geometry reacts to light, providing inputs for diffuse and specular texture maps, bump mapping, and environmental maps, which mimic reflection and refraction.
Material Components

All the standard illumination models share certain characteristics that must be understood.

Diffuse
The Diffuse parameters of a material control the appearance of an object where light is absorbed or scattered. This diffuse color and texture are the base appearance of an object, before taking into account reflections. The opacity of an object is generally set in the diffuse component of the material.

Alpha
The Alpha parameter defines how much the object is transparent to diffuse light. It does not affect specular levels or color. However, if the value of alpha, either from the slider or a Material input from the diffuse color, is very close to or at zero, those pixels, including the specular highlights, will be skipped and disappear.

Opacity
The Opacity parameter fades out the entire material, including the specular highlights. This value cannot be mapped; it is applied to the entire material.

Specular
The Specular parameters of a material control the highlight of an object where the light is reflected to the current viewpoint. This causes a highlight that is added to the diffuse component. The more specular a material is, the glossier it appears. Surfaces like plastics and glass tend to have white
specular highlights, whereas metallic surfaces like gold have specular highlights that tend to inherit their color from the material color.

Specularity is made up of color, intensity, and exponent. The specular color determines the color of light that reflects from a shiny surface. Specular intensity is how bright the highlight will be.

The specular exponent controls the falloff of the specular highlight. The larger the value, the sharper the falloff and the smaller the specular component will be.

Transmittance
When using the software renderer, the Transmittance parameters control how light passes through a semi-transparent material. For example, a solid blue pitcher will cast a black shadow, but one made of translucent blue plastic would cast a much lower density blue shadow. The transmittance parameters are essential to creating the appearance of stained glass.

**TIP:** You can adjust the opacity and transmittance of a material separately. It is possible to have a surface that is fully opaque yet transmits 100% of the light arriving upon it, so in a sense it is actually a luminous/emissive surface.

Transmissive surfaces can be further limited using the Alpha and Color Detail control.
Attenuation
The transmittance color determines how much color is passed through the object. For an object to have fully transmissive shadows, the transmittance color must be set to RGB = (1, 1, 1), which means 100% of green, blue, and red light passes through the object. Setting this color to RGB = (1, 0, 0) means that the material will transmit 100% of the red arriving at the surface but none of the green or blue light.

Alpha Detail
When the Alpha Detail slider is set to 0, the non-zero portions of the alpha channel of the diffuse color are ignored and the opaque portions of the object casts a shadow. If it is set to 1, the alpha channel determines how dense the object casts a shadow.

**NOTE:** The OpenGL renderer ignores alpha channels for shadow rendering, resulting in a shadow always being cast from the entire object. Only the software renderer supports alpha in the shadow maps.

The following examples for Alpha Detail and Color Detail cast a shadow using this image. It is a green-red gradient from left to right. The outside edges are transparent, and inside is a small semi-transparent circle.

Alpha Detail set to 1; the alpha channel determines the density of the shadow

Alpha Detail set to 0; a dense-colored shadow results

Color Detail
Color Detail is used to color the shadow with the object’s diffuse color. Increasing the Color Detail slider from 0 to 1 brings in more diffuse color and texture into the shadow.
**Tip:** The OpenGL renderer will always cast a black shadow from the entire object, ignoring the color. Only the software renderer supports color in the shadow maps.

---

**Saturation**

Saturation will allow the diffuse color texture to be used to define the density of the shadow without affecting the color. This slider lets you blend between the full color and luminance only.

**Transmittance and Shadows**

The transmittance of an object’s material plays an important role in determining the appearance of the shadow it casts. Normally, the transmittance behavior is defined in each object’s Materials tab as explained above. However, selecting Force All Materials Non-Transmissive in the Spotlight Inspector overrides this, causing the shadow map produced by the spotlight to ignore transmittance entirely.

**Illumination Models**

Now that you understand the different components that make up a material or shader, we’ll look at them more specifically. Illumination models are advanced materials for creating realistic surfaces like plastic, wood, or metal. Each illumination model has advantages and disadvantages, which make it appropriate for particular looks. An illumination model determines how a surface reacts to light, so these nodes require at least one light source to affect the appearance of the object. Four different illumination models can be found in the Nodes > 3D > Material menu.

---

**Standard**

The Standard material provides a default Blinn material with basic control over the diffuse, specular, and transmittance components. It only accepts a single texture map for the diffuse component with the alpha used for opacity. The Standard Material controls are found in the Material tab of all nodes that load or create geometry. Connecting any node that outputs a material to that node’s Material Input will override the Standard material, and the controls in the Material tab will be hidden.
Blinn

The Blinn material is a general purpose material that is flexible enough to represent both metallic and dielectric surfaces. It uses the same illumination model as the Standard material, but the Blinn material allows for a greater degree of control by providing additional texture inputs for the specular color, intensity, and exponent (falloff), as well as bump map textures.

Phong

The Phong material produces the same diffuse result as Blinn, but with wider specular highlights at grazing incidence. Phong is also able to make sharper specular highlights at high exponent levels.

Cook-Torrance

The Cook-Torrance material combines the diffuse illumination model of the Blinn material with a combined microfacet and Fresnel specular model. The microfacets need not be present in the mesh or bump map; they are represented by a statistical function, Roughness, which can be mapped. The Fresnel factor attenuates the specular highlight according to the Refractive Index, which can be mapped.

Ward

The Ward material shares the same diffuse model as the others but adds anisotropic highlights, ideal for simulating brushed metal or woven surfaces, as the highlight can be elongated in the U or V directions of the mapping coordinates. Both the U and V spread functions are mappable.

This material does require properly structured UV coordinates on the meshes it is applied to.

Textures

Texture maps modify the appearance of a material on a per-pixel basis. This is done by connecting an image or other material to the inputs on the Material nodes in the Node Editor. When a 2D image is used, the UV mapping coordinates of the geometry are used to fit the image to the geometry, and when each pixel of the 3D scene is rendered, the material will modify the material input according to the value of the corresponding pixel in the map.

**TIP:** UV Mapping is the method used to wrap a 2D image texture onto 3D geometry. Similar to X and Y coordinates in a frame, U and V are the coordinates for textures on 3D objects.

Texture maps are used to modify various material inputs, such as diffuse color, specular color, specular exponent, specular intensity, bump map, and others. The most common uses of texture maps is the diffuse color/opacity component.

A node that outputs a material is frequently used, instead of an image, to provide other shading options. Materials passed between nodes are RGBA samples; they contain no other information about the shading or textures that produced them.
The Texture2D node is used to translate a texture in the UV space of the object, as well as set the filtering and wrap mode.

Composite Materials

Building complex materials is as easy as connecting the output of a Material node to one of the Material inputs of another Material or Texture node. When a Material input is supplied just as with a 2D image, its RGBA values are used per pixel as a texture. This allows for very direct compositing of shaders.

For instance, if you want to combine an anisotropic highlight with a Blinn material, you can take the output of the Blinn, including its specular, and use it as the diffuse color of the Ward material. Or, if you do not want the output of the Blinn to be relit by the Ward material, you can use the Channel Boolean material to add the Ward material's anisotropic specular component to the Blinn material with a greater degree of control.

Combining an anisotropic highlight with a Blinn material using the Channel Boolean material.

Reflections and Refractions

Environment maps can be applied with the Reflect material in the 3D > Material category. This node can be used to simulate reflections and refractions on an object. Reflections are direct-bounce light that hits an object, while refractions simulate the distortion of light seen through semi-translucent surfaces.

The reflections and refractions use an environment mapping technique to produce an approximation that balances realistic results with greater rendering performance. Environment maps assume an object’s environment is infinitely distant from the object and rendered into a cubic or spherical texture surrounding the object.

The Nodes > 3D > Texture > Cube Map and Sphere Map nodes can be used to help create environment maps, applying special processing and transforms to create the cubic or spherical coordinates needed.
To produce reflections with real-time interactive feedback at a quality level appropriate for production environment maps, you make some trade-offs on functionality when compared with slower but physically accurate raytraced rendering. Environment-mapped reflections and refractions do not provide self-reflection or any other kind of interaction between different objects. In particular, this infinite distance assumption means that objects cannot interact with themselves (e.g., the reflections on the handle of a teapot will not show the body of the teapot). It also means that objects using the same cube map will not inter-reflect with each other. For example, two neighboring objects would not reflect each other. A separate cube map must be rendered for each object.

The Reflect node outputs a material that can be applied to an object directly, but the material does not contain an illumination model. As a result, objects textured directly by the Reflect node will not respond to lights in the scene. For this reason, the Reflect node is usually combined with the Blinn, Cook-Torrance, Phong, or Ward nodes.

Reflection
Reflection outputs a material making it possible to apply the reflection or refraction to other materials either before or after the lighting model with different effects.

Refraction
Refraction occurs only where there is transparency in the background material, which is generally controlled through the Opacity slider and/or the alpha channel of any material or texture used for the Background Material Texture input. The Reflect node provides the following material inputs:
- **Background Material**: Defines both the opacity for refraction and the base color for reflection.
- **Reflection Color Material**: The environment reflection.
- **Reflection Intensity Material**: A multiplier for the reflection.
- **Refraction Tint Material**: The environment refraction.
- **Bump Map Texture**: Normal perturbing map for environment reflection/refraction vectors.

Working with reflection and refraction can be tricky. Here are some techniques to make it easier:
- Typically, use a small amount of reflection, between 0.1 and 0.3 strength. Higher values are used for surfaces like chrome.
- Bump maps can add detail to the reflections/refractions. Use the same bump map in the Illumination model shader that you combine with Reflect.
- When detailed reflections are not required, use a relatively small cube map, such as 128 x 128 pixels, and blur out the image.
- The alpha of refracted pixels is set to 1 even though the pixels are technically transparent. Refracted pixels increase their alpha by the reflection intensity.
- If the refraction is not visible even when a texture is connected to the Refraction Tint Material input, double-check the alpha/opacity values of the background material.

**Bump Maps**

Bump mapping helps add details and small irregularities to the surface appearance of an object. Bump mapping modifies the geometry of the object or changes its silhouette.

![Split screen of a sphere—half with bump map, half without](image)

To apply a bump map, you typically connect an image containing the bump information to the BumpMap node. The bump map is then connected to the Bump input of a Material node. There are two ways to create a bump map for a 3D material: a height map and a bump map.

![Image connected to a BumpMap connected to a CookTorrance material node](image)

**Using a Height Map**

A height map is an image where the value of a pixel represents the height. It is possible to select which color channel is used for bump creation. White means high and black means low; however, it is not the value of a pixel in the height map that determines the bumpiness, but rather how the value changes in the neighborhood of a pixel.
Using a Bump Map

A bump map is an image containing normals stored in the RGB channels.

**TIP:** Normals are generated by 3D modeling and animation software as a way to trick the eye into seeing smooth surfaces, even though the geometry used to create the models uses only triangles to build the objects.

Normals are 3 float values (nx, ny, nz) whose components are in the range \([-1, +1]\). Because you can store only positive values in Fusion’s integer images, the normals are packed from the range \([-1, +1]\) to the range \([0, 1]\) by multiplying by 0.5 and adding 0.5. You can use Brightness Contrast or a Custom node to do the unpacking.

If you were to connect a bump map directly to the bump map input of a material, it will result in incorrect lighting. Fusion prevents you from doing this, however, because Fusion uses a different coordinate system for doing the lighting calculation. You first must use a BumpMap that expects a packed bump map or height map and will do the conversion of the bump map to work correctly.

If your bump mapping doesn’t appear correct, here are a few things to look for:

- Make sure you have the nodes connected correctly. The height/bump map should connect into a BumpMap and then, in turn, should connect into the bump map input on a material.
- Change the precision of the height map to get less banding in the normals. For low frequency images, float32 may be needed.
- Adjust the Height scale on the BumpMap. This scales the overall effect of the bump map.
- Make sure you set the type to HeightMap or BumpMap to match the image input. Fusion cannot detect which type of image you have.
- Check to ensure High Quality is on (right-click in the transport controls bar and choose High Quality from the contextual menu). Some nodes like Text+ produce an anti-aliased version in High Quality mode that will substantially improve bump map quality.
- If you are using an imported normal map image, make sure it is packed \([0–1]\) in RGB and that it is in tangent space. The packing can be done in Fusion, but the conversion to tangent space cannot.

Projection Mapping

Projection is a technique for texturing objects using a camera or projector node. This can be useful for texturing objects with multiple layers, applying a texture across multiple separate objects, projecting background shots from the camera’s viewpoint, image-based rendering techniques, and much more.

There are three ways to do projection mapping in Fusion.

Using the Projector/Camera Tool to Project Light

When lighting is enabled, a Camera 3D or Projector 3D can act as a light with all the lighting features. When Camera Projection is enabled or you use a projector, you can choose whether the projection behaves like a spotlight or an ambient light; however, alpha channels cannot be projected. Overlapping projections add together like any other light node. An internal clipping plane (at around 0.01 distance from camera) limits how close the projector or camera can get to the receivers of the projection.
Project a Texture onto a Catcher Material

If you do not want to work with light sources, you can use the projector or camera as a texture projector. To work without lighting, a catcher is required in order to receive the texture and apply it to a material. Only objects using this material will receive the projection. This offers some advantages, like the projection of alpha channels, and texturing other channels like specular color or roughness. If the software renderer is used, overlapping projections can be combined in various ways (mean, median, blend, and so on) via the Catcher node. When using the OpenGL renderer, one catcher per projector is used, and the results can be combined using another material. Similar to the Light Projection technique, an internal clipping plane (at around 0.01 distance from camera) limits how close the projector/camera can get to the projection receivers.
Project Using the UVMap Node

This mode requires a camera and a UVMap3D node downstream of the objects to which the texture is being projected. In the Inspector, when the UVMap Map mode is set to Camera, it gathers the information from the camera and creates new UVs for the input objects, which are used for texturing. Because the UVs are stored in the vertices of the mesh, the object must be tessellated sufficiently.

Textures are assigned to the object like any other texturing technique. The UVs can be locked to the vertices at a chosen frame using the Ref Time slider. This locking only works as long as vertices are not created, destroyed, or reordered (e.g., projection locking will not work on particles because they get created/destroyed, nor will they work on a Cube3D when it’s subdivision level slider animated).

TIP: Projected textures can be allowed to slide across an object. If the object moves relative to the Projector 3D, or alternatively, by grouping the two together with a Merge3D, they can be moved as one and the texture will remain locked to the object.

In the following section of a much larger composition, an image (the Loader1 node) is projected into 3D space by mapping it onto five planes (Shape3D nodes renamed ground, LeftWall, RightWall, Building, and Background), which are positioned as necessary within a Merge3D node to apply reflections onto a 3D car to be composited into that scene.

The output of the Merge3D node used to assemble those planes into a scene is then fed to a UV Map node, which in conjunction with a Camera3D node correctly projects all of these planes into 3D space so they appear as they would through that camera in the scene. Prior to this UVMap projection, you can see the planes arranged in space at left, where each plane has the scene texture mapped to it. At right is the image after the UVMap projection, where you can see that the scene once again looks “normal,” with the exception of a car-shaped hole introduced to the scene.
However, this is now a 3D scene, ready for a digital car to be placed within it, receiving reflections and lighting and casting shadows into the scene as if it were there.

The new 3D scene casting reflections and lighting onto a 3D car, and receiving shadows caused by the car

**Geometry**

There are five nodes used for creating geometry in Fusion. These nodes can be used for a variety of purposes. For instance, the Image Plane 3D is primarily used to place image clips into a 3D scene, while the Shapes node can add additional building elements to a 3D set, and Text 3D can add three-dimensional motion graphics for title sequences and commercials. Although each node is covered in more detail in the “3D Nodes” chapter, a summary of the 3D creation nodes is provided below.

**Cube 3D**

The Cube 3D creates a cube with six inputs that allow mapping of different textures to each of the cube’s faces.

**Image Plane 3D**

The Image Plane 3D is the basic node used to place a 2D image into a 3D scene with an automatically scaled plane.

**Shape 3D**

This node includes several basic primitive shapes for assembling a 3D scene. It can create planes, cubes, spheres, cylinders, cones, and toruses.

**Text 3D**

The Text 3D is a 3D version of the Text+ node. This version supports beveling and extrusion but does not have support for the multi-layered shading model available from Text+.

**Particles**

When a pRender node is connected to a 3D view, it will export its particles into the 3D environment. The particles are then rendered using the Renderer3D instead of the Particle renderer. For more information, see Chapter 113, “Particle Nodes” in the DaVinci Resolve Reference Manual or Chapter 52 in the Fusion Reference Manual.
Common Visibility Parameters

Visibility parameters are found in the Controls tab of most 3D geometry-producing nodes, exposed via a disclosure control. These parameters let you control object visibility in the viewers and in the final render.

Visible

If the Visibility checkbox is not selected, the object will not be visible in a viewer, nor will it be rendered into the output image by a Renderer3D. A non-visible object does not cast shadows. This is usually enabled by default, so objects that you create are visible in both the viewers and final renders.

Unseen by Cameras

If the Unseen by Cameras checkbox is selected, the object will be visible in the viewers but invisible when viewing the scene through a camera, so the object will not be rendered into the output image by a Renderer3D. Shadows cast by an Unseen object will still be visible.

Cull Front Face/Back Face

Use these options to cull (exclude) rendering of certain polygons in the geometry. If Cull Back Face is selected, all polygons with normals pointing away from the view will not be rendered and will not cast shadows. If Cull Front Face is selected, all polygons with normals pointing away from the view will likewise be excluded. Selecting both checkboxes has the same effect as deselecting the Visible checkbox.

Ignore Transparent Pixels in Aux Channels

For any piece of geometry, the Renderer3D rejects transparent pixels in the auxiliary image channels. The reason this is the default is to prevent aux channels (e.g., normals, Z-channel, UVs) from filling in where there should be blank space or full transparency. For example, suppose in post you want to add some fog to the rendered image. If you had fully transparent geometry in the foreground affecting the Z-channel, you would get incorrect fog rendering. By deselecting this checkbox, the transparency will not be considered and all the aux channels will be filled for all the pixels. This could be useful if you wanted to replace texture on a 3D element that is fully transparent in certain areas with a texture that is transparent in different areas; it would be useful to have the whole object set aux channels (in particular UVs).

Adding FBX Models

The Filmbox FBX format is a scene interchange format that facilitates moving 3D scene information from one application to another. Fusion’s FBX format support extends model import support to other 3D files such as Collada and OBJ.

Importing an FBX Scene

To import an entire FBX scene, you add an FBXMesh3D node to your node tree. After being prompted to choose a scene or object file, Fusion imports it to create a composition with the same lights, cameras, materials, and geometry found in an FBX file.
FBX Scene Import Dialog

The FBX Mesh node is used to import mesh geometry from an FBX file. The first texture applied to a mesh will also be imported, if available.

Since different 3D applications use different units to measure their 3D scenes, the imported geometry may be enormous compared to the rest of the scene, because Fusion treats its scale of measurement as equal to its own system. For example, if your 3D application defaults to using millimeters as its scale, an object that was 100 millimeters in size will import as a massive 100 units.

You can use the Size slider in the FBX Mesh Inspector parameters to reduce the scale of such files to something that matches Fusion's 3D scene.

FBX Exporter

You can export a 3D scene from Fusion to other 3D packages using the FBX Exporter node. On render, it saves geometry, cameras lights, and animation into different file formats such as .dae or .fbx. The animation data can be included in one file, or it can be baked into sequential frames. Textures and materials cannot be exported.

Using Text3D

The Text3D node is probably the most ubiquitous node employed by motion graphics artists looking to create titles and graphics from Fusion. It's a powerful node filled with enough controls to create nearly any text effect you might need, all in three dimensions. This section seeks to get you started quickly with what the Text3D node is capable of. For more information, see Chapter 90, "3D Nodes" in the DaVinci Resolve Reference Manual or Chapter 29 in the Fusion Reference Manual.
Assembling Text Objects

Each Text3D node is a self-contained scene within which each character of text is an individual object. Because of this, the ideal way to combine numerous text objects that you might want to animate or style independently from one another is to connect as many Text3D objects as you want to be able to independently animate or style to one or more Merge3D nodes.

Merging multiple text objects to create an intricately styled scene

**TIP:** If you click the Text icon in the toolbar to create a Text3D node, and then you click it again while the Text3D node you just created is selected, a Merge3D node is automatically created and selected to connect the two. If you keep clicking the Text icon, more Text3D nodes will be added to the same selected Merge3D node.

Entering Text

When you select a Text3D node and open the Inspector, the Text tab shows a “Styled Text” text entry field at the very top into which you can type the text you want to appear onscreen. Below, a set of overall styling parameters are available to set the Font, Color, Size, Tracking, and so on. All styling you do in this tab affects the entire set of text at once, which is why you need multiple text objects if you want differently styled words in the same scene.

The text entry and styling parameters in the Text tab
Near the bottom of the Text tab are the Extrusion parameters, available within a disclosure control.

![Extrusion parameters](image)

The Extrusion parameters near the bottom of the Text tab

By default, all text created with the Text3D node is flat, but you can use the Extrusion Style, Extrusion Depth, and various Bevel parameters to give your text objects thickness.

![Unextruded text (left), and Extruded text (right)](image)

**Positioning and Transforming Text**

By default, every new Text3D node is positioned at 0, 0, 0, so when you add multiple Text3D nodes, they’re all in the same place. Fortunately, every Text3D node has built-in transform controls in the Transform tab.

![Text3D nodes also have Transform parameters built-in](image)
Additionally, selecting a Text3D node exposes all the onscreen transform controls discussed elsewhere in this chapter. Using these controls, you can position and animate each text object independently.

![Repositioned text objects to create a title sequence](image)

Combining Text3D nodes using Merge3D nodes doesn’t just create a scene; it also enables you to transform your text objects either singly or in groups:

- Selecting an individual Text3D node or piece of text in the viewer lets you move that one text object around by itself, independently of other objects in the scene.
- Selecting a Merge3D node exposes a transform control that affects all objects connected to that Merge3D node at once, letting you transform the entire scene.

Layout Parameters

The Layout tab presents parameters you can use to choose how text is drawn: on a straight line, a frame, a circle, or a custom spline path, along with contextual parameters that change depending on which layout you’ve selected (all of which can be animated).

![Text using two different layouts](image)

“Sub” Transforms

Another Transform tab (which the documentation has dubbed the “Sub” Transform tab) lets you apply a separate level of transform to either characters, words, or lines of text, which lets you create even more layout variations. For example, choosing to Transform by Words lets you change the spacing between words, rotate each word, and so on. You can apply simultaneous transforms to characters, words, and lines, so you can use all these capabilities at once if you really need to go for it. And, of course, all these parameters are animatable.
Transforming individual words in two different ways

**Shading**

The Shading tab lets you shade or texture a text object using standard Material controls.

**Fog 3D and Soft Clipping**

The Fog3D node helps to create atmospheric depth cues.
The Fog3D node works well with depth of field and antialiasing supported by the OpenGL renderer. Since it is not a post-processing node (like the VolumeFog node found in the Nodes > Position menu or Fog node in Nodes > Deep Pixel), it does not need additional channels like Position or Z-channel color. Furthermore, it supports transparent objects.

The SoftClip node uses the distance of a pixel from the viewpoint to affect opacity, allowing objects to gradually fade away when too close to the camera. This prevents objects from “popping off” should the camera pass through them. This is especially useful with particles that the camera may be passing through.

Geometry nodes such as the Shape3D node use a Matte Objects checkbox to enable masking out parts of the 3D scene. Effectively, everything that falls behind a matte object doesn’t get rendered. However, matte objects can contribute information into the Z-channel and the Object ID channel, leaving all other channels at their default values. They do not remove or change any geometry; they can be thought of as a 3D garbage matte for the renderer.

Matte Object Parameters

Opening the Matte disclosure control reveals the Is Matte option, which when turned on enables two more options.
Is Matte
Located in the Controls tab for the geometry, this is the main checkbox for matte objects. When enabled, objects whose pixels fall behind the matte object’s pixels in Z do not get rendered.

Opaque Alpha
When the Is Matte checkbox is enabled, the Opaque Alpha checkbox is displayed. Enabling this checkbox sets the alpha value of the matte object to 1. Otherwise the alpha, like the RGB, will be 0.

Infinite Z
When the Is Matte checkbox is enabled, the Infinite Z checkbox is displayed. Enabling this checkbox sets the value in the Z-channel to infinite. Otherwise, the mesh will contribute normally to the Z-channel.

Matte objects cannot be selected in the viewer unless you right-click in the viewer and choose 3D Options > Show Matte Objects in the contextual menu. However, it’s always possible to select the matte object by selecting its node in the node tree.

Material and Object IDs

Most nodes in Fusion that support effect masking can use Object ID and Material ID auxiliary channels to generate a mask. The parameters used to accomplish this are found in the Common Controls tab of each node.

![Material ID parameters in a Shape3D node’s Inspector controls](image)

The Material ID is a value assigned to identify what material is used on an object. The Object ID is roughly comparable to the Material ID, except it identifies objects and not materials.

Both the Object ID and Material ID are assigned automatically in numerical order, beginning with 1. It is possible to set the IDs to the same value for multiple objects or materials even if they are different. Override 3D offers an easy way to change the IDs for several objects. The Renderer will write the assigned values into the frame buffers during rendering, when the output channel options for these buffers are enabled. It is possible to use a value range from 0 to 65534. Empty pixels have an ID of 0, so although it is possible to assign a value of 0 manually to an object or material, it is not advisable because a value of 0 tells Fusion to set an unused ID when it renders.

![Object ID for ground plane and object set to the same numeric value](image)
The World Position Pass, or WPP, is a render pass generated from 3D applications. Each pixel is assigned the XYZ position where the pixel was generated in the world coordinates. So if the face from which the pixel was derived in the scene sits at (0,0,0), the resulting pixel will have a Position value of (0,0,0). If we visualize this as RGB, the pixel will be black. If a face sits at (1,0,0) in the original scene, the resulting RGB pixel will be red. Due to the huge range of possible positions in a typical 3D scene, and 7/8 of those possible positions containing negative coordinates, the Position channel is always rendered in 32-bit float.

A World Position Pass rendering of a scene with its center at (0,0,0) The actual image is on the left

3D Scene Input

Nodes that utilize the World Position channel are located under the Position category. VolumeFog and Z to WorldPos require a camera input matching the camera that rendered the Position channels, which can either be a Camera3D or a 3D scene containing a camera. Just as in the Renderer3D, you can choose which camera to use if more than one are in the scene. The VolumeFog can render without a camera input from the Node Editor if the world space Camera Position inputs are set to the correct value. VolumeMask does not use a camera input. Nodes that support the World Position Pass, located under the Position category, offer a Scene input, which can be either a 3D Camera or a 3D scene containing a camera.

There are three Position nodes that can take advantage of World Position Pass data.

- Nodes > Position > Volume Fog
- Nodes > Position > Volume Mask
- Nodes > Position > Z to World
- The “Dark Box”

Empty regions of the render will have the Position channel incorrectly initialized to (0,0,0). To get the correct Position data, add a bounding sphere or box to your scene to create distant values and allow the Position nodes to render correctly.
Without a bounding mesh to generate Position values, the fog fills in the background incorrectly.

Point Clouds

The Point Cloud node is designed to work with locator clouds generated from 3D tracking software. 3D camera tracking software, such as SynthEyes and PF Track, will often generate hundreds or even thousands of tracking points. Seeing these points in the scene and referencing their position in 3D and screen space is important to assist with lining up live action and CG, but bringing each point in as an individual Locator3D would impact performance dramatically and clutter the node tree.

The Point Cloud node can import point clouds written into scene files from match moving or 3D scanning software.

To import a point cloud, do the following:
1. Add the PointCloud3D node to your composition.
2. Click the Import Point Cloud button in the Control panel.
3. Browse to the scene file and select a cloud to import from the scene.

The entire point cloud is imported as one object, which is a significantly faster approach.
Finding, Naming, and Publishing Points

Many 3D trackers allow for the naming of individual tracking points, as well as setting tracking points on points of interest. The Point Cloud 3D will quickly find these points and publish them. A published point in the cloud can be used to drive the animation of other parameters.

To find a point in the point cloud, do the following:

1. Right-click anywhere within a viewer.
2. Choose Find from the Point Cloud’s submenu in the contextual menu.
3. Type the name of the point and click OK.

If a point that matches the name you entered is found, it will be selected in the point cloud and highlighted yellow.

**TIP:** The Point Cloud Find function is a case-sensitive search. A point named “tracker15” will not be found if the search is for “Tracker15.”
Renaming a Point in the Cloud
You can use the Point Cloud contextual menu to rename a selected point. This works only for a single point. A group of points cannot be renamed.

Publishing a Point
If you want to use a point’s XYZ positions for connections to other controls in the scene, you can publish the point. This is useful for connecting objects to the motion of an individual tracker. To publish a point, right-click it and choose Publish from the contextual menu.
Chapter 87

3D Camera Tracking

This chapter presents an overview of using the Camera Tracker node and the workflow it involves. Camera tracking is used to create a virtual camera in Fusion’s 3D environment based on the movement or a live-action camera in a clip. You can then use the virtual camera to composite 3D models, text, or 2D images into a live-action clip that has a moving camera.

For more information on other types of tracking in Fusion, see Chapter 83, “Using the Tracker Node” in the DaVinci Resolve Reference Manual or Chapter 22 in the Fusion Reference Manual.

Contents

Introduction to Tracking ........................................ 1580
What Is 3D Camera Tracking? ......................... 1580
How Camera Tracking Works ...................... 1580
The Camera Tracking Workflow .............. 1581
Clips That Don’t Work Well for Camera Tracking 1581
Outputting from the Camera Tracker .......... 1582
2D View .................................................................. 1583
3D View .................................................................. 1583
Auto-Tracking in the Camera Tracker ........ 1584
Increasing Auto-Generated Tracking Points 1584
Masking Out Objects ...................................... 1585
Matching the Live-Action Camera ............ 1587
Running the Solver .......................................... 1587
How Do You Know When to Stop? ............ 1588
Using Seed Frames .......................................... 1589
Cleaning Up Camera Solves ................... 1589
Introduction to Tracking

Tracking is one of the most useful and essential techniques available to a compositor. It can roughly be defined as the creation of a motion path from analyzing a specific area in a clip over time. Fusion provides a variety of different tracking nodes that let you analyze different kinds of motion. Each tracker type has its own chapter in this manual. This chapter covers the tracking techniques with the Camera Tracker node.

What Is 3D Camera Tracking?

Camera tracking is used for match moving, and it's a vital link between 2D scenes and 3D scenes, allowing compositors to integrate 3D CGI elements into live-action clips. The Camera Tracker node calculates the path of a live-action camera and generates a virtual camera in 3D space. This virtual camera is intended to be identical to the actual camera that shot the scene, not only in terms of motion but in matching the lens focal length as well. The calculated position and movement of the virtual camera is central to realistically compositing 3D elements with live action.

How Camera Tracking Works

Camera tracking begins by tracking the movement of fixed features from one frame to the next. To put it another way, camera tracking algorithms follow features that are “nailed to the set.” Objects in the scene that move independently of the camera movement in the shot, such as cars driving or people walking, cause poor tracks, so masks can be used to restrict the features that are tracked in order to improve the results. Additionally, it is helpful to provide specific camera metadata, such as the sensor size and the focal length of the lens. This information guides the scene reconstruction calculation, called a solver, toward generating a more accurate virtual camera.
The Camera Tracker’s purpose is to create a 3D animated camera and point cloud of the scene. A point cloud is a large group of points generated by the solver that roughly recreates the 3D positions of the tracked features in a scene. The point cloud can then be used as a guide when integrating other 2D or 3D elements alongside live-action features.

**The Camera Tracking Workflow**

*Camera tracking has two main phases:*

1. **Tracking**, which is the analysis of a scene.
2. **Solving**, which calculates the virtual 3D scene.

Once you complete these steps, an animated camera and point cloud are exported from the Inspector into a 3D composite. The Camera Tracker encompasses this complete workflow within one tool. Five tabs at the top of the Inspector are roughly laid out in the order in which you’ll use them. These five tabs are:

- **Track**: Used to track a clip.
- **Camera**: Configures the basic Camera parameters.
- **Solve**: Calculates the 3D placement of the 2D tracking points and reconstructs the camera.
- **Export**: Generates a Camera 3D node, a Point Cloud node, and a 3D scene in the node tree.
- **Options**: Used to customize the look of the onscreen overlays.

![](image)

**The Camera Tracker tab**

**Clips That Don’t Work Well for Camera Tracking**

Even though the Camera Tracker is somewhat automatic, it sometimes needs your help. If you can identify potential issues before you even track or solve the shot, you can save yourself much time. Certain types of clips will cause more significant problems for camera tracking than others. Some are fixable, while for others you just have to admit defeat and figure out another solution. Here is a list of the types of shots to look out for, as they can be big headaches for camera tracking:

- **Lack of depth**: Camera tracking requires parallax in a clip in order to work. You must be able to identify objects further away and objects that are nearer as the camera moves. If everything is at the same distance from the camera, there is no way to calculate depth. In this case, it’s better to skip the Camera Tracker node and find another solution.

- **Locked-off shots**: If the camera does not move, there is no way to calculate which objects are closer and which are nearer. Again, don’t spend too much time in this situation; it is better to skip the Camera Tracker node and find another solution.
- **Tripod pans:** Similar to a locked-off shot, there is no way to calculate which objects are closer and which are nearer from a pan that remains centered on a locked-off tripod. Skip the Camera Tracker node and find another solution.

- **No detail:** Clips like green screens without tracking markers lack enough detail to track. If you are lucky enough to be involved in the shooting of these types of shots, including tracker markers makes it much easier to get a good track. Without detail, camera tracking will fail and you will need to find a more manual solution.

- **Motion blur:** Fast camera motion or slow shutter speeds can introduce motion blur, which will make it difficult to find patterns to track. It’s worth trying shots like these to see if there are enough details to get a good solve, but know when give up and turn to another solution.

- **Rolling shutter:** CMOS-based cameras sometimes introduce distortion due to the shutter capturing different lines at slightly different times. This distortion can create significant problems for camera tracking. Sometimes it is possible to create motion vectors with the Optical Flow node to create new in-between frames without the wobble distortion of the rolling shutter. Then you can use the corrected image to connect to the Camera Tracker.

- **Parallax issues:** When objects at different distances in a shot overlap in the frame, the overlapping area can be misinterpreted as a corner. Having a tracker assigned to an overlapping angle like this will cause errors as the parallax starts to shift and the overlapping area slides. This can be solved in Fusion by removing that tracker before running the solver.

- **Moving objects:** It’s difficult to capture a shot where objects in the clip do not move. People, cars, animals, or other object may move in and out of a shot. These objects move independent of the camera movement and must be eliminated or they will cause solving errors. You can fix these issues by masking out objects that are not “nailed to the set.” The masks are then connected to the Track Mask input on the Camera Tracker node.

**TIP:** Some shots that cannot be tracked using Fusion’s Camera Tracker can be performed in dedicated 3D camera-tracking software like 3D Equalizer and PF Track. Camera tracking data from these applications can then be imported in the Camera3D node in Fusion.

**Outputting from the Camera Tracker**

Unlike most Fusion nodes, the Camera Tracker node has two outputs:

- The primary output is a 2D view used when you are setting up the Track, refining the camera, and performing your initial solve.

- There is also a 3D output used after your initial solve for viewing the camera path and point cloud in 3D space. This view can be helpful when you are refining tracks to increase the accuracy of the solve and aligning your ground plane. It can be used simultaneously with the 2D output in side-by-side views.

Note that the selection of tracks in the 2D view and their corresponding locators (in the point cloud) in the 3D view are synchronized. There are also viewer menus available in both the 2D and 3D views to give quick control of the functionality of this tool.
**2D View**

The 2D view is the primary display for the node. Viewing the node displays the image being tracked as well as overlay tracker markers and their motion paths. A dedicated toolbar gives you access to the common features used to track and solve a clip.

![The Camera Tracker 2D output with toolbar and auto-track points](image)

**3D View**

The second output of the Camera Tracker node displays a 3D scene. To view this, connect this 3D output to a 3D Transform or Merge 3D node and view that tool.

![After solving, connecting the second output of the Camera Tracker node to a Merge 3D displays the point cloud in 3D](image)
After an initial solve, the 3D output displays the point cloud and the camera, along with the image connected to it. Selecting points displays the Camera Tracker toolbar above the viewer, which gives control of various functions, such as renaming, deleting, and changing the colors of points in the point cloud.

Auto-Tracking in the Camera Tracker

Tracking is the term used to describe the task of observing or analyzing a sequence of frames (or clip). The Camera Tracker node must take into account the movement of the source footage before it can determine the location and movement of the virtual camera. The Camera Tracker tool automatically searches for features that are high-contrast patterns within the clip and assigns trackers to those features. Having a wide distribution of tracking points across the frame and having points with long durations results in the best track.

Increasing Auto-Generated Tracking Points

Unlike the Tracker node, setting tracking points is entirely automatic in the Camera Tracker, but the Detection Threshold and Minimum Feature Separation sliders let you adjust the criteria by which tracking points are found. Lowering these parameters lets you increase the number of tracking points that will be found. This can be useful if the scene has too few points, which will prevent the solver from generating an accurate camera and point cloud. However, make these adjustments with care, since adding too many points may generate redundant trackers that slow down the entire process with minimal benefit.

Previewing Tracking Points

You can view the tracking points currently generated on the clip by viewing the Camera Tracker node and turning on the Preview AutoTrack Locations checkbox. This causes green tracking points to be displayed in the viewer as you play through the clip. Using this preview, you can decide whether you need to make adjustments to the Detection Threshold or Minimum Feature Separation to increase or decrease the number of tracking points that are found automatically.
Green tracker marks are added automatically to the features in an image

Bi-Directional Tracking
When performing a track, you can enable the Bidirectional Tracking checkbox, which first tracks forward from the start of the clip, and then tracks a second pass in reverse. This two-pass approach can potentially extend the duration of any given point by re-analyzing points initially identified in the forward pass. There is very little reason not to have this enabled unless you are very short on time. Bidirectional tracking takes longer, but it’s usually worth it, and the process is reasonably quick considering the benefit.

Choosing a Tracking Algorithm
There are three available choices for the algorithm to use when tracking. The three options in the New Track Defaults section of the Inspector include:

– **Optical Flow**: Usually your best choice, unless you have a great deal of criss-crossing objects in a clip.

– **Tracker**: A good second choice when Optical Flow can’t be used due to motion estimation errors like criss-crossing objects.

– **Planar**: Mostly used in simpler clips, where the majority of the image consists of planar surfaces such as the facades of buildings.

Masking Out Objects
When tracking a clip, the Camera Tracker automatically generates trackers on feature details. However, not all features that stand out in a clip are appropriate for camera tracking. You only want to track features that are “nailed to the set.” In other words, objects that move independently of the camera motion, like moving cars and people, cause inaccuracies when camera tracking. You must eliminate these types of objects from the analysis.

The primary way of avoiding these problem areas is by masking. You connect a mask to the Camera Tracker node’s Track Mask input to identify areas of a scene that the Camera Tracker can analyze. For example, if you have a clip of an airport runway along a shoreline, the waves of the water and moving clouds in the sky must be masked since they move independently of the camera.
When creating a mask, the fixed areas of the image to be analyzed for tracking should be encompassed in the white portion of the mask. All moving objects that need to be ignored should be encompassed in the black portion. The mask should then be attached to the Camera Tracker Track Mask input.

Masks used to omit the moving clouds and waves from being tracked by the Camera Tracker

By doing this, the tracker ignores the waves of the water and moving clouds. Unlike drawing a mask for an effect, the mask in this case does not have to be perfect. You are just trying to identify the rough area to occlude from the tracking analysis.

The original image to be tracked (left), and the occlusion mask of the clouds and water (right)

**TIP:** If there’s a lot of motion in a shot, you can use the Tracker or Planar Tracker nodes to make your occlusion mask follow the area you want to track. Just remember that, after using the PlanarTracker or PlanarTransform node to transform your mask, you need to use a Bitmap node to turn it back into a mask that can be connected to the Camera Tracker node’s Track Mask input.
Matching the Live-Action Camera

Once you have completed tracking, the next stage of this workflow requires the controls in the Camera tab. This is where you define the actual camera used on set, primarily the film gate size and focal length. This information should have been logged on the set to make available for post-production. When using camera-original media, you can sometimes locate this information in the file metadata.

To locate camera metadata, do the following:

- If you are using DaVinci Resolve, select the MediaIn node with the camera clip, open the Metadata Editor, and view the Camera metadata preset.
- If you are using Fusion Studio, display the metadata subview from the viewer toolbar.

If the actual values are not known, try a best guess. The solver attempts to find a camera near these parameters, and it helps the solver by giving parameters as close to the live action as possible. The more accurate the information you provide, the more accurate the solver calculation. At a minimum, try to at least choose the correct camera model from the Film Gate menu. If the film gate is incorrect, the chances that the Camera Tracker correctly calculates the lens focal length become very low.

Running the Solver

The next step in this workflow involves the controls found in the Solve tab. Solving is a compute-intensive process in which the Camera Tracker analyzes the currently existing tracks to create a 3D scene. It generates a virtual camera that matches the live action and a point cloud consisting of 3D locators that recreate the tracked features in 3D space. The analysis is based on parallax in the frame, which is the perception that features closer to the camera move quicker than features further away. This is much like when you look out the side window of a car and can see objects in the distance move more slowly than items near the roadside.

The trackers found in the Track phase of this workflow have a great deal to do with the success or failure of the solver, making it critical to deliver the best set of tracking points from the very start. Although the masking you create to occlude objects from being tracked helps to omitted problematic tracking points, you almost always need to further filter and delete poor quality tracks in the Solver tab. That’s why, from a user’s point of view, solving should be thought of as an iterative process.
To solve a camera’s motion:

1. Click the Solve button to run the solver.
2. Filter out and delete poor tracks.
3. Rerun the solver.

![The Solver tab after it has run and produced an average solve error of 0.4367 pixels](image)

**How Do You Know When to Stop?**

At the end of the solve process, an Average Solve Error (sometimes called a reprojection error) appears at the top of the Inspector. This is the crucial value that tells you how well the calculation has gone. A good Average Solve Error for HD content is below 1.0.

You can interpret a value of 1.0 as a pixel offset; at any given time, the track could be offset by 1 pixel. The higher the resolution, the lower the solve error should be. If you are working with 4K material, your goal should be to achieve a solve error below 0.5.

**Tips for Solving Camera Motion**

When solving camera movement, it’s important to provide accurate live-action camera information, such as focal length and film gate size, which can significantly improve the accuracy of the camera solve. For example, if the provided focal length is too far away from the correct physical value, the solver can fail to converge, resulting in a useless solution.

Additionally, for the solver to accurately triangulate and reconstruct the camera and point cloud, it is important to have:

- A good balance of tracks across objects at different depths, with not too many tracks in the distant background or sky (these do not provide any additional perspective information to the solver).
- Tracks distributed evenly over the image and not highly clustered on a few objects or one side of the image.
- The track starts and ends staggered over time, with not too many tracks ending on the same frame.
Using Seed Frames

The solver works by first constructing a partial solution between two seed frames. These seed frames are selected automatically. However, automatic selection adds time to the process. The time is reported in the solve summary at the top of the Inspector once you run the solver. You can select your own seed frames to speed the process and potentially get a better solve on trickier clips. The solver uses these seed frames to create an intermediate solution and then extends this forward and backward for the duration of the clip.

Selecting appropriate seed frames is not necessarily recommended unless you have some experience with camera tracking. Keeping the default Auto Select Seed Frames checkbox enabled in the Solve Options section of the Solver tab selects the best frames in most cases. However, you can disable the checkbox and use the Seed Frame 1 and Seed Frame 2 slider to select frames you believe achieve better results.

When choosing seed frames, it is important to satisfy two main characteristics:

– Seed frames should have lots of tracks in common.
– Seed frames should be far apart in perspective.

Sometimes There’s Nothing You Can Do

Some shots that do not have enough camera motion to triangulate feature locations cannot be reconstructed with any useful accuracy. Ensuring that a shot is camera-trackable begins on set, with proper usage of track markers, and by ensuring that camera moves have enough perspective shifts for the solver to glean useful data from.

Cleaning Up Camera Solves

Sometimes the first solve will be good enough. Other times, it may take a few hours of cleaning up tracks to get a good solve, and sometimes it is impossible. With experience, one gets a feel for which tracks should be deleted and which should be kept, and which shots will be easy, difficult, or impossible to solve.

Be aware that deleting too many tracks can cause the Average Solve Error to increase, as the solver has too little information to work with. In particular, if there are fewer than eight tracks on any frame, mathematically there is not enough information to solve the clip. However, it is strongly recommended to use a lot more than eight tracks to get a robust and accurate solve.

IMPORTANT

If you are not familiar with camera tracking, it may be tempting to try to directly edit the resulting 3D splines in the Spline Editor in order to improve a solved camera’s motion path. This option should be used as an absolute last resort. It’s preferable, instead, to modify the 2D tracks being fed into the solver.
How to Judge Track Accuracy

The automatic color coding of tracking markers makes deleting false or poor tracks easier. After the solver runs, each tracker is assigned a solve error color that indicates which 3D locators match their 2D tracking points well, and which match up poorly.

- **Green**: Good. Tracked very well.
- **Yellow**: Moderate confidence. Usually an acceptable track.
- **Orange**: Low Confidence. May be acceptable in some situations.
- **Red**: No Confidence. The tracks have not solved well.

Hovering the pointer over any tracking point displays a large metadata tooltip that includes the solve error for the point. For a more visual representation of the accuracy, you can enable the display of 3D locators in the viewer by clicking the Reprojection Locators button in the viewer toolbar.

![After a solve, the Camera Tracker toolbar can display Reprojection locators](image)

When the tracking points are converted into a point cloud by the solver, it creates 3D reprojection locators for each tracking point. These Reprojection locators appear as small X marks near the corresponding tracking point. The more the two objects overlap, the lower the solve error.

![Reprojection locators displayed with tracking points, and tooltip](image)

The goal when filtering the trackers is to remove all red tracker marks and keep all the green marks. Whether you decide to keep both the yellow and orange or just the yellow is more a question of how many marks you have in the clip. You produce a better solve if you retain only the yellow marks; however, if you do not have enough marks to calculate the 3D scene, you will have to keep some of the better orange marks as well.
Tips for What to Keep and What to Delete

Understanding what false tracks look like, and then manually cleaning the track data to reduce it to a precise set of clear tracks, will result in a more accurate solve. When cleaning up any track—particularly yellow and orange color coded tracks—keep the following in mind:

- Keep all tracks with motion that’s completely determined by the motion of the live-action camera.
- Delete tracks on moving objects or people and tracks that have parallax issues.
- Delete tracks that are reflected in windows or water.
- Delete tracks of highlights that move over a surface.
- Delete tracks that do not do a good job of following a feature.
- Delete tracks that follow false corners created by the superposition of foreground and background layers.
- Consider deleting tracks that correspond to locators that the solver has reconstructed at an incorrect Z-depth.

Deleting Tracks

You can manually delete tracks in the viewer or use filters to select groups of tracks. When deleting tracks in the viewer, it is best to modify the viewer just a bit to see the tracks more clearly. From the Camera Tracker toolbar above the viewer, clicking the Track Trails button hides the trails of the tracking points. This cleans up the viewer to show points only, making it easier to make selections. At the right end of the toolbar, clicking the Darken Image button slightly darkens the image, again making the points stand out a bit more in the viewer.

To begin deleting poor-quality tracks, you can drag a selection box around a group of tracks you want to remove and then either click the Delete Tracks button in the Camera Tracker toolbar or press Command-Delete.

You can hold down the Command key to select discontiguous tracking marks that are not near each other. If you accidentally select tracks you want to keep, continue holding the Command key and drag over the selected tracks to deselect them.

When deleting tracks, take note of the current Average Solve Error at the top of the Inspector and then rerun the solver. It is better to delete small groups of tracks and then rerun the solver than to delete one or two large sections. As mentioned previously, deleting too many tracks can have adverse effects and increase the Average Solve Error.

Using Filters to Delete Problem Tracks

The Solve tab includes filters that can be used to select groups of similar tracks by track length, track error, and solve error. These can be used to quickly select and delete poorly performing tracks that may be misleading to the resulting camera, leaving a concise list of accurate tracks.
Tracks can be selected using filters and deleted using the Operations On Selected Tracks buttons.

For instance, it is generally best to run the solver using tracks with longer durations. Since shorter tracks tend to be less accurate when calculating the camera, you can remove them using the Filter section in the Inspector.

Increasing the Minimum Track Length parameter sets a threshold that each tracker must meet. Tracks falling below the threshold appear red. You can then click the Select Tracks Satisfying Filters button to select the shorter tracks and click Delete from the Options section in the Inspector.

Exporting a 3D Scene for Efficiency

The Camera Tracker saves all its 2D tracks into the composition, sometimes resulting in a rather large file on disk. If you are dealing with a large clip with many 2D tracks over a long duration, the saved composition can reach over a gigabyte in size. Using a Camera Tracker node in a composition can make it cumbersome to load and operate. While it is possible to use the Camera Tracker node directly to composite via the 3D output, you’ll achieve better performance by exporting. Once the quality of the solve is satisfactory, the Export tab can generate a “low memory” alternative by producing individual Camera 3D, Point Cloud, Ground Plane, and 3D Renderer nodes.

Before you can export the 3D scene, you must provide a bit more information about it. You’ll do this using controls found in the Export tab. Cameras do not include tiltmeters, so clips do not contain metadata that indicates how the camera is tilted or oriented. This is critical information when recreating the virtual camera. It is also useful to determine the location for the center of this 3D scene. The Export tab provides various translation, rotation, and scale controls to set these options.

Unalign the 3D Scene Transforms

By default, the Export tab is set to Aligned in the 3D Scene Transform section. The Aligned setting locks the orientation and scale of the 3D scene to prevent accidentally changing it. So, before you can set the ground plane and origin location, you must change the Camera Tracker to be unaligned using the 3D Scene Transform menu in the Export tab. After you have gone through the Export settings and configured them how you want, you must set the menu back to Aligned before exporting.
Setting the Ground Plane

The Camera Tracker has no idea if the camera is on its side or tilted in some way. So, it is up to you to indicate where the ground plane is in a clip. After choosing Unaligned from the 3D Scene Transform menu, you can begin identifying the ground plane.

To set the ground plane, do the following:

1. Move to a frame with lots of green 3D locators where you can see a large part of the ground.
2. In the viewer, drag a selection box around the marks located on the ground in the clip.
3. In the Inspector Orientation section, click the Set from Selection button.

**TIP:** In some cases, the clip you are tracking may not have the ground in the frame. If necessary, you can set the Selection menu to XY, which indicates you are selecting points on a wall.

Setting the Origin

When it comes time to add and position new objects into your 3D scene, you can make it easier by setting the origin or center location.

To set the origin of the 3D scene, do the following:

1. Move to a frame that clearly shows the area you want to select as the center of the scene.
2. In the viewer, either select a single point or drag a selection box around a few marks located where you want to position the center of the 3D scene.
3. In the inspector Origin section, click the Set from Selection button.
**Setting the Scale**

The Camera Tracker has no idea of the size of the 3D scene, so the scale parameter is used to scale the scene output. This makes it possible to match the scale of two or more clips.

**Realign the Scene**

Before exporting the scene from the Camera Tracker, you must set the 3D scene Transform menu back to Aligned. Now you're ready to export.

**Viewing the Exported Results**

Clicking the Export button at the top of the Inspector creates a functional 3D scene with five new nodes automatically added to the node tree.

- Camera 3D
- Point Cloud
- Ground Plane
- Merge 3D
- Camera Tracker Renderer (3D Renderer)

To work with the 3D scene, you can select the Merge 3D and load it into one of the viewers, and then select the Camera Tracker Renderer and load that into a second viewer.
When the Merge 3D is selected, a toolbar above the viewer can add 3D test geometry like an image plane or cube to verify the precision of the 3D scene and camera. You can then connect actual 3D elements into the Merge 3D as you would any manually created 3D scene. The point cloud can help align and guide the placement of objects, and the CameraTracker Renderer is a Renderer 3D node with all the same controls.

At this point, there is no need for the Camera Tracker node unless you find that you need to rerun the solver. Otherwise, you can save some memory by deleting the Camera Tracker node.
This chapter is designed to give you a brief introduction to the creation of fully 3D particle systems, one of Fusion’s most powerful features. Once you understand these basics, for more information on each particle system node that’s available, see Chapter 113, “Particle Nodes” in the DaVinci Resolve Reference Manual or Chapter 52 in the Fusion Reference Manual.

Contents

- Introduction to Particle Systems 1597
- Anatomy of a Simple Particle System 1598
- Particle System Distribution 1600
- Particle Nodes Explained by Type 1601
  - Emitters 1601
  - Forces 1602
  - Compositing 1602
  - Rendering 1602
- Example Particle Systems 1603
Introduction to Particle Systems

Particle systems are computer simulations that use customizable rules to automatically generate and animate large numbers of elements to simulate smoke, dust, fire, leaves, sparks, or any other animated system of shapes. As Fusion is a full-featured 3D compositing environment, particle systems can be created in 2D or 3D, which makes them incredibly flexible and capable of producing all kinds of visual effects or abstract animated content for use in motion graphics.

A 3D particle system, also created entirely within Fusion

The three most fundamental nodes required for creating particle systems are found on the toolbar. As with the 3D nodes to the right, these are arranged, from left to right, in the order in which they must be connected to work, so even if you can’t remember how to hook up a simple particle system, all you need to do is click the three particle system nodes from left to right to create a functional particle system.

The pEmitter, pMerge, and pRender particle system nodes available from the toolbar

However, these three nodes are only the tip of the iceberg. Opening the Particle category in the Effects Library reveals many, many particle nodes designed to work together to create increasingly complex particle interactions.

A sample of the nodes available in the Particles bin of the Effects Library
All particle nodes begin with the letter “p,” and they’re designed to work together to produce sophisticated effects from relatively simple operations and settings. The next section shows different ways particle nodes can be connected to produce different effects.

**Anatomy of a Simple Particle System**

The simplest particle system you can create is a pEmitter node connected to a pRender node. The pEmitter node includes the core controls for creating various kinds of particles in different ways, while the pRender node is required to render a 2D or 3D result that can be composited with other scenes within your composition.

![The minimum node tree required to create a simple particle system](image)

If your needs are more complicated, you can combine two or more pEmitter nodes using a pMerge node (the particle system version of a Merge node), to create compound particle systems where multiple types of particles combine with one another to create a result.

![Compositing two pEmitter nodes to create a compound particle system, combining two kinds of particles together](image)

If you’re trying to create particle systems with more natural effects, you can add “forces” to each emitter. These forces are essentially physics or behavioral simulations that automatically cause the particles affected by them to be animated with different kinds of motion, or to be otherwise affected by different objects within scenes.

![Customizing the effect of pEmitter nodes using different forces to add complexity to the particle animation](image)

You can also attach the following types of nodes to a pEmitter node to deeply customize a particle system:

- Attach a 2D image to a pEmitter node to create highly customized particle shapes. Make sure your image has an appropriate alpha channel.
- Attach a Shape3D or other 3D geometry node to a pEmitter node to create a more specific region of emission (by setting Region to Mesh in the Region tab).
Customizing pEmitter nodes using mesh geometry to define regions and 2D images to define particle shape

The above examples assume that you’ll output 2D renders to combine into the rest of a 2D composition. However, because particle systems are fully 3D, you also have the option of outputting your particle system in such a way as to be used from within other 3D scenes in your composition.

Connecting a particle system to a Merge3D node so the particles are subject to lighting and shadows within a 3D scene

The Output Mode of the pRender node, at the very top of the controls exposed in the Inspector, can be set to either 2D or 3D, depending on whether you want to combine the result of the particle system with 2D layers or with objects in a 3D scene.

Choosing whether a particle system’s output is 2D or 3D in the pRender node’s Inspector controls

If you connect a pRender node to a Merge3D node, the Output Mode is locked to 3D, meaning that 3D geometry is output by the pRender node for use within the Merge3D node’s scene. This means that the particles can be lit, they can cast shadows, and they can interact with 3D objects within that scene.
The result of using a particle system within a 3D scene

**NOTE:** Once you set the pRender node to either 2D or 3D and make any change to the nodes in the Inspector, you cannot change the output mode.

### Particle System Distribution

To adjust the distribution of particles being emitted, select the pEmitter node to expose its controls in the Inspector, then open the Velocity controls in the Controls tab, and use the Angle, Angle Variance, Angle Z, and Angle Z Variance controls to adjust the direction and width over which particles are emitted. All these controls can be animated.

A pEmitter node’s Velocity Angle and Angle Variance controls let you adjust the direction and width of particle distribution.

Particle systems can be positioned and rotated by loading the pEmitter nodes that generate particles into a viewer and using the onscreen 3D position and Rotation controls provided to move the particle system around.
A pEmitter node loaded into the viewer with the rotation onscreen controls enabled

Alternatively, you can use the controls of the pEmitter’s Region tab in the Inspector to adjust Translation, Rotation, and Pivot. All these controls can be animated.

A pEmitter node’s Region controls open in the Inspector

Particle Nodes Explained by Type

This section introduces the four types of particle system nodes available in the Effects Library.

Emitters

pEmitter nodes are the source of all particles. Each pEmitter node can be set up to generate a single type of particle with enough customization so that you’ll never create the same type of particle twice. Along with the pRender node, this is the only other node that’s absolutely required to create a particle system.
pEmitter nodes have four parameters tabs:

- **Controls**: The primary controls governing how many particles are generated (Number), how long they live (Lifespan), how fast they move (Velocity) and how widely distributed they are (Angle and Angle Variance), their rotation (Rotation Mode with X, Y, and Z controls), and whether there's spin (Spin X, Y, and Z controls). For each parameter of particle generation, there’s an accompanying Variance control that lets you make that parameter less uniform and more natural by introducing random variation.

- **Sets**: This tab contains settings that affect the physics of the particles emitted by the node. These settings do not directly affect the appearance of the particles. Instead, they modify behaviors such as velocity, spin, quantity, and lifespan.

- **Style**: While the Controls tab has a simple control for choosing a color for particles, the Style tab has more comprehensive controls including color variance and Color Over Life controls. Additionally, size controls including Size Over Life, fade controls, and blur controls let you create sophisticated particle animations with a minimum of adjustments, while Merge controls give you an additional level of control over how overlapping particles combine visually. A set of controls at the bottom lets you choose how animated effects are timed.

- **Region**: The Region tab lets you choose what kind of geometric region is used to disperse particles into space and whether you’re emitting particles from the region’s volume or surface. The Winding Rule and Winding Ray Direction controls determine how the mesh region will handle particle creation with geometric meshes that are not completely closed, as is common in many meshes imported from external applications. Tweaking these last parameters is common when using imported mesh geometry as a region for emitting particles, since even geometry that appears closed will frequently appear to “leak” particles thanks to improperly welded vertices.

### Forces

Many of the particle nodes found in the Particles bin of the Effects Library are “forces” that enhance a particle simulation by simulating the effect of various forces acting upon the particles generated by an emitter.

Some forces, including pDirectionalForce, pFlock, pFriction, pTurbulence, and pVortex, are rules that act upon particles without the need for any other input. These are simply “acts of nature” that cause particles to behave in different ways.

Other forces, such as pAvoid, pBounce, pFollow, and pKill, work in conjunction with 3D geometry in a scene such as shapes or planes to cause things to happen when a particle interacts or comes near that geometry. Note that some of the particles described previously can also use geometry to direct their actions, so these two categories of forces are not always that clear-cut.

### Compositing

The pMerge node is a simple way to combine multiple emitters so that different types of particles work together to create a sophisticated result. The pMerge node has no parameters; you simply connect emitters to it, and they’re automatically combined.

### Rendering

The pRender node is required whether you’re connecting a particle system’s output to a 2D Merge node or to a Merge3D node for integration into a 3D scene. Along with the pEmitter node, this is the only other node that’s absolutely required to create a particle system.

- **Controls**: The main controls that let you choose whether to output 2D or 3D image data, and whether to add blur or glow effects to the particle systems, along with a host of other details controlling how particles will be rendered.

- **Scene**: These controls let you transform the overall particle scene all at once.
– **Grid**: The grid is a helpful, non-rendering guide used to orient 2D particles in 3D space. The grid is never output in renders. The width, depth, number of lines, and grid color can be set using the controls found in this tab.

– **Image**: Controls the output of the pRender node, with controls over the process mode, resolution, and color space settings of the output.

### Example Particle Systems

The Templates category in the Inspector in the Fusion page of DaVinci Resolve or in the Bins window in Fusion Studio includes over 20 different examples of particle systems creating a variety of effects. One of the best ways of learning how to create and customize particle systems is to open these and investigate how they’re made.

![Different particle system presets in the Templates category of the Bins window in Fusion Studio](image)

Simply drag and drop any of the particle presets into the Node Editor, load the last node into the viewer, and you’ll see how things are put together.

![The Blowing Leaves preset from the Templates category](image)
This chapter covers the numerous stereoscopic and optical flow-based nodes available in Fusion and their related workflows.

Contents

Overview 1605
Stereoscopic Overview 1605
Optical Flow Overview 1606
Toolset Overview 1606
Working with Aux Deep Channels 1607
Optical Flow Workflows 1608
OpticalFlow 1608
TimeSpeed, TimeStretcher 1608
SmoothMotion 1608
Repair Frame, Tween 1608
Advanced Optical Flow Processing 1608
Stereoscopic Workflows 1609
Stereo Camera 1609
Stereo Materials 1610
Disparity 1611
NewEye, StereoAlign 1611
DisparityToZ, ZToDisparity 1611
Separate vs. Stack 1611
Overview

Fusion includes 3D stereoscopic and optical flow-based nodes, which can work together or independently of each other to create, repair, and enhance 3D stereoscopic shots.

Stereoscopic Overview

All stereoscopic features are fully integrated into Fusion's 3D environment. Stereoscopic images can be created using a single camera, which supports eye separation and convergence distance, and a Render 3D for the virtual left and right eye. It is also possible to combine two different cameras for a stereo camera rig.

Stereoscopic nodes can be used to solve 3D stereoscopic shooting issues, like 3D rig misalignment, image mirror polarization differences, camera timing sync issues, color alignment, convergence, and eye separation issues. The stereo nodes can also be used for creating depth maps.
Optical Flow Overview

Optical Flow analyzes the motion in a clip and generates motion vectors between neighboring frames. It generates X and Y vectors from the previous frame to the current frame (Back Vectors) and to the next frame in sequence (Forward Vectors). Once calculated, optical flow data can be used by other nodes to create smooth slow motion and variable retiming of clips, repair missing frames, and even correct disparity in stereo 3D clips.

**NOTE:** The stereoscopic nodes in the Fusion page work independently of the stereoscopic tools in the other DaVinci Resolve pages.

Toolset Overview

Here is an overview of the available nodes.

**Optical Flow Nodes**
- **Optical Flow > OpticalFlow:** Analyzes motion between neighboring frames in a sequence to generate motion vectors, which can then be used by other nodes for retiming, motion blur, and other effects.
- **Miscellaneous > TimeSpeed:** Retimes a clip at a constant speed using Flow Interpolation mode.
- **Miscellaneous > TimeStretcher:** Retimes a clip at variable speeds using Flow Interpolation mode.
- **Optical Flow > RepairFrame:** Generates a new frame using the motion vectors between two neighboring frames.
- **Optical Flow > SmoothMotion:** Smoothes the color or aux channels using motion vectors.
- **Optical Flow > Tween:** Interpolates between two non-sequential images to generate a new frame.
- **Color > CopyAux:** Copies aux channels, including motion vectors, into RGBA more efficiently than Channel Booleans.

**Stereoscopic Nodes**
- **Stereo > Anaglyph:** Combines stereo images to create a single anaglyph image for viewing.
- **Stereo > Combiner:** Stacks a separate stereo images into a single stacked pair, so they can be processed together.
- **Stereo > Disparity:** Generates disparity between left/right images.
- **Stereo > DisparityToZ:** Converts disparity to Z-depth.
- **Stereo > Global Align:** Shifts each stereo eye manually to do basic alignment of stereo images.
- **Stereo > NewEye:** Replaces left and/or right eye with interpolated eyes.
- **Stereo > Splitter:** Separates a stacked stereo image into to left and right images.
- **Stereo > StereoAlign:** Adjusts vertical alignment, convergence, and eye separation.
- **Stereo > ZToDisparity:** Converts Z-depth to disparity.
Working with Aux Deep Channels

Certain image formats can contain channels other than RGBA color, called aux deep channels. Stereo Disparity and OpticalFlow deal directly with auxiliary deep channels.

**Aux channels supported in Fusion include:**
- **RGBA:** These are the standard colors.
- **Z:** The eyespace Z coordinate is almost always negative because in eyespace, Fusion’s camera sits at (0, 0, 0) looking down the Z-axis. Z values start at Z = 0 at the camera focal point and progressively become more negative for objects deeper in the scene.
- **Coverage:** The percentage of the pixel covered by the frontmost pixel, used for antialiased Z-compositing.
- **Object ID:** These are user-assigned integers to meshes.
- **Material ID:** These are user-assigned integers to materials.
- **Texture Coords:** Normalized texture coordinates stored as (u, v) pairs.
- **Normal Vector:** Normal vector (nx, ny, nz) where the components are typically in the range [-1, +1].
- **Background Color:** The color of the pixel if the frontmost layer were removed, used for antialiased Z-compositing.
- **Vector:** The forward motion vector is an offset (vx, vy) that compares every pixel’s position in one frame to the same pixel’s position in the next frame.
- **Back Vector:** The backward motion vector is an offset (vx, vy) that compares every pixel’s position in one frame to the same pixel’s position in the previous frame.
- **World Position:** The position (wx, wy, wz) of the pixel in world coordinates.
- **Disparity:** An offset (dx, dy) that maps a pixel in the Left > Right or Right > Left frames.

**Some extra channels are used by specific Fusion nodes.**

For example:
- Merge can use the Z channel to perform a depth merge. If the Coverage and BackgroundColor channels are present, it can do a better job on antialiased edges during the Z merge.
- Most image-processing nodes (e.g., BrightnessContrast) have options on their common controls tab to limit their processing by MaterialID and ObjectID.
- The Fog and DepthBlur nodes make use of the Z channel.
- The Texture node makes use of the TexCoord channel.
- The Shader node makes use of the Normal channel.

**There are a couple of ways to retrieve or generate those extra channels within Fusion.**

For example:
- The Renderer3D node is capable of generating most of these channels.
- The OpticalFlow node generates the Vector and BackVector channels, and then TimeStretcher and TimeSpeed can make use of these channels.
- The Disparity node generates the Disparity channels, and then DisparityToZ, NewEye, and StereoAlign nodes can make use of the Disparity channels.
- The OpenEXR format can be used to import or export aux channels into Fusion by specifying a mapping from EXR attributes to Fusion Aux channels using CopyAux.
Optical Flow Workflows

The Optical Flow analysis is a non-real-time process, and depending on your computer, the clip’s resolution, and the duration of the clip, it can take some time. Because of this, the general idea is that you pre-generate the motion vectors, either by performing the analysis overnight or using a render farm, and save results into an OpenEXR sequence. The Optical Flow toolset is designed around four types of nodes that either generate, destroy, pass through, or construct the motion vectors.

OpticalFlow

The Optical Flow node generates the Vector and BackVector data. Typically, for optimal performance, you connect the Optical Flow output to a Saver to save the image as OpenEXR files with the motion vectors stored in an aux channel.

TimeSpeed, TimeStretcher

You can create smooth constant or variable slow-motion effects using the TimeSpeed or TimeStretcher nodes. When Optical Flow motion vectors are available in the aux channel of an image, enabling Flow mode in the TimeSpeed or TimeStretcher Interpolation settings will take advantage of the Vector and BackVector channels. For the Flow mode to work, there must be either an upstream OpticalFlow node generating the hidden channels or an OpenEXR Loader bringing these channels in. These nodes use the Vector/BackVector data to do interpolation on the motion channel and then destroy the data on output since the input Vector/BackVector channels are invalid. For more detail on TimeSpeed or TimeStretcher, see Chapter 110, "Miscellaneous Nodes" in the DaVinci Resolve Reference Manual and Chapter 49 in the Fusion Reference Manual.

SmoothMotion

SmoothMotion can be used to smooth the Vector and BackVector channels or smooth the disparity in a stereo 3D clip. This node passes through, modifies, or generates new aux channels, but does not destroy them.

Repair Frame, Tween

The Tween and Repair Frame nodes are different from standard optical flow nodes because they have the OpticalFlow analysis and motion vector generation built in. Tween will compare two frames and create an in-between frame, which is good for recreating a missing or flawed frame. Repair Frame will look at frames on either side of the current frame and repair scratches, dust marks, and so on. Because these nodes work with flow values between non-sequential frames, they cannot use the optical flow stored in the input image’s Vector/BackVector channels, but rather must regenerate the flow of each frame, do their processing, and then destroy the flow channels. This being the case, these nodes are computationally expensive. For more detail on Tween or Repair Frame, see Chapter 111, "Optical Flow" in the DaVinci Resolve Reference Manual and Chapter 50 in the Fusion Reference Manual.

Advanced Optical Flow Processing

The Optical Flow, Repair Frame, and Tween nodes include a faster GPU-based Optical Flow algorithm. When you add the Optical Flow, Repair Frame, or Tween node to a comp, the Inspector includes a Method drop-down menu where you can choose Advanced to enable the GPU-based algorithm. This Advanced method is the same Optical Flow algorithm used in other DaVinci Resolve pages.

By choosing Classic from the Method drop-down menu in the Inspector, you can use the older CPU-based algorithm to maintain compatibility with comps created in previous versions. This method may also be better suited for some Stereo3D processing.
Stereoscopic Workflows

Disparity is the difference between the left and right image. The Disparity map is used by nodes to align and massage the stereo pair of images.

The Disparity node analyzes a stereo pair of images and generates an X&Y disparity map.

The workflow is to load a left and right stereo image pair and process those in the Disparity node. Once the Disparity map is generated, other nodes can process the images.

**TIP:** When connecting stereo pairs in the node tree, make sure that the left and right images are connected to the left and right inputs of the Disparity node.

Disparity generation, like Optical Flow, is computationally expensive, so the general idea is that you can pre-generate these channels, either overnight or on a render farm, and save them into an EXR sequence.

The toolset is designed around this philosophy.

**Stereo Camera**

There are two ways to set up a stereoscopic camera. The common way is to simply add a Camera 3D and adjust the eye separation and convergence distance parameters.
Stereoscopic cameras can be done with a single camera or two connected cameras.

The other way is to connect another camera to the RightStereoCamera input port of the Camera 3D. When viewing the scene through the original camera or rendering, the connected camera is used for creating the right-eye content.

**Stereo Materials**

Using the Stereo Mix material node, it is possible to assign different textures per eye.
**Disparity**

The Disparity node does the heavy lifting of generating disparity maps. This generates the Disparity channel and stores it in the hidden aux channels of their output image.

**NewEye, StereoAlign**

NewEye and StereoAlign use and destroy the Disparity channel to do interpolation on the color channel.

The hidden channels are destroyed in the process because, after the nodes have been applied, the original Disparity channels would be invalid.

For these nodes to work, there must be either an upstream Disparity node generating the hidden channels or an OpenEXR Loader bringing these channels in.

**DisparityToZ, ZToDisparity**

These nodes pass through, modify, or generate new aux channels, but do not destroy any.

**TIP:** If the colors between shots are different, use Color Corrector or Color Curves to do a global alignment first before calculating the Disparity map. Feed the image you will change into the orange input and the reference into the green input. In the Histogram section of the Color Corrector, select Match, and also select Snapshot Match Time. In the Color Curves’ Reference section, select Match Reference.

**Separate vs. Stack**

Stereo nodes can work in Separate or Stack modes. When in Stack mode, the left/right eyes are stacked horizontally or vertically, forming one image with double width or height, respectively.

The advantage to using Stack mode is that you do not have to have duplicate branches of the Node Editor for the left and right eyes. As a consequence, you will see Stereo nodes with two inputs and two outputs labeled as “Left” and “Right.”

When in Stack mode, the stack should be connected to the left eye input and the Left output should be used for connecting further nodes. In Stack mode, the respective Right eye inputs and outputs are hidden.

**Setting Up Stereo in the Node Editor**

The disparity generation is the first operation. This can be configured in the Node Editor in two different ways.
Two stereoscopic workflows.

In the above example, the workflow on the right takes the left and right eye, generates the disparity, and then NewEye is used to generate a new eye for the image right away.

The example on the left renders the frames with disparity to intermediate EXR images. These images are then loaded back into Stereo nodes and used to create the NewEye images.

By using Render nodes to compute the disparity first, the later processing of the creative operations can be a much faster and interactive experience.

Although not shown in the above diagram, it is usually a good idea to color correct the right eye to be similar to the left eye before disparity generation, as this helps with the disparity-tracking algorithm. The color matching does not need to be perfect—for example, it can be accomplished using the “Match” option in a Color Corrector’s histogram options.

About the Disparity Channel

The Disparity channel stores the displacement vectors that match pixels in one eye to the other eye. The left image’s Disparity channel will contain vectors that map left>right and the right image’s Disparity channel will contain vectors that map right>left. For example:

\((x_{left}, y_{left}) + (D_{left}. x, D_{left}. y) \rightarrow (x_{right}, y_{right})\)

\((x_{right}, y_{right}) + (D_{right}. x, D_{right}. y) \rightarrow (x_{left}, y_{left})\)

You would expect for non-occluded pixels that \(D_{left} = -D_{right}\), although, due to the disparity generation algorithm, this is only an approximate equality.

**NOTE:** Disparity stores both X and Y values because rarely are left/right images perfectly registered in Y, even when taken through a carefully set up camera rig.

Both Disparity and Optical Flow values are stored as un-normalized pixel shifts. In particular, note that this breaks from Fusion’s resolution-independent convention. After much consideration, this convention was chosen so the user wouldn’t have to worry about rescaling the Disparity/Flow values when cropping an image or working out scale factors when importing/exporting these channels to other applications. Because the Flow and Disparity channels store things in pixel shifts, this can cause problems with Proxy and AutoProxy. Fusion follows the convention that, for proxied images, these channels store unscaled pixel shifts valid for the full-sized image. So if you wish to access the Disparity values in a script or via a probe, you need to remember to always scale them by \((\text{image. Width}/\text{image. OriginalWidth}, \text{image. Height}/\text{image. OriginalHeight})\).
Viewing of Disparity and Vector Channels

Aux channels can be displayed directly in the viewers through the Channel viewer button’s menu. The CopyAux node is used to copy those channels directly into the RGB channels for viewing or further processing. The advantage of using the CopyAux node is that it does static normalization, which reduces a lot of flicker that the viewer’s time-variant normalization causes. When viewing long sequences of aux channels, the CopyAux node has the option to kill off aux channels and keep only the current RGB channels, freeing up valuable memory so you can cache more frames.

**TIP:** Although you can use the Channel Booleans to copy any aux channel into RGBA, it involves a few additional clicks when compared to CopyAux.

One thing to be aware of is that aux channels tend to consume a lot of memory. A float-32 1080p image containing just RGBA uses about 32 MB of memory, but with all the aux channels enabled it consumes around 200 MB of memory.

Stereo and Optical Flow Best Practices

How you create your composition, the images you are using, and the type of shot you are working on can all have an impact on the success of the Disparity generation and Optical Flow analysis. Below, we’ll look at some of the situations to be aware of and how you can avoid some pitfalls when dealing with optical flow.

**Semi-Transparent Objects**

The Optical Flow and Disparity generation algorithms Fusion uses assume there is only one layer per pixel when tracking pixels from frame to frame. In particular, transparent objects and motion blur will cause problems. For example, a shot flying through the clouds with the semi-transparent clouds in the foreground and a distant landscape background will confuse the Optical Flow/Stereo algorithms, as they do not recognize overlapping objects with different motions. Usually the optical flow will end up tracking regions of one object or the other. If the transparent object and the background are near the same depth and consequently have the same disparity, then it is not a problem.

**Motion Blur**

Motion blur is also a serious problem for the reason explained in the previous point. The Disparity and Optical Flow algorithms are unsure whether to assign a pixel in the motion blur to the moving object or the background pixel. Because the algorithms used are global in nature, not only the vectors on the motion blur will be wrong, but it will confuse the algorithm on regions close to the motion blur.

**Depth of Field**

Depth of field is also another problem related to the above two problems. The problem occurs when you have a defocused foreground object over a background object that is moving (Optical Flow case) or shifts between L/R (Stereo Disparity case). The blurred edges will confuse the tracking because they can’t figure out that the edges are actually two separate objects.
Where to Calculate Disparity and Optical Flow?

Where you choose to generate optical flow or disparity in your composition can drastically affect the results.

For example, if you have composited a lens flare in, it is better to compute OpticalFlow/Disparity before that, since the semi-transparent lens flare will confuse the tracking algorithms.

If you are color correcting the left/right eyes to match or for deflickering, it is better to apply the OpticalFlow/Disparity afterward, since it will be easier for the tracking algorithm to find matches if the color matches between frames.

If you are removing lens distortion, think carefully about whether you want to do it before or after Disparity computation. If you do it after, your Disparity map will also act as a lens distortion map, combining the two effects as one.

As a general rule of thumb, it is best to use OpticalFlow/Disparity before any compositing operations except an initial color matching correction and a lens distortion removal.

Cropping the Source

As a general tip, if you are cropping down your input images for any reason, it is probably better to compute the optical flow or disparity before the crop and then afterward crop the flow/disparity along with the color.

The reason is that flow/disparity matching works well when there is common pixel data to match in both frames, but when there are pixels that show up in just one frame (or one eye), then the Disparity/OpticalFlow nodes must make a guess and fill in the data. The biggest occlusions going from L <--> R are usually pixels along the L/R edges of the images that get moved outside. This is similar for optical flow when you have a moving camera.

Another thing to be aware of are black borders around the edges of your frames, which you should crop away.

Nodes with Multiple Outputs

Many of the stereo nodes in the Fusion toolset have multiple outputs. This can cause some confusion to new users. One particularly confusing thing is that when you drag a Stereo node to the view, it will always display the left output. There is no way to view the right output without connecting another node like BC (BrightnessContrast) to the right output and viewing that.

Picking from Aux Channels

Some nodes, like StereoAlign, allow one to drag pick from the Z or Disparity auxiliary channels. You must pick from a node upstream of the StereoAlign, not from the output of the StereoAlign. If you try to pick a disparity from the output of a StereoAlign node, you will get nothing because StereoAlign consumes/destroys the Disparity aux channel (and even if it did not destroy the Disparity channel, you would still be picking the wrong value since you would be picking from the aligned result).

The typical workflow for picking is:

1 View StereoAlign in the left view.
2 View the node upstream of StereoAlign in the right view.
3 Pick the Disparity value from the left eye in the right view.
Although this picking functionality does not operate any differently from normal picking of color channels, this issue may cause some confusion. If it helps, the analogous workflow mistake with color nodes would be a user trying to pick a gradient color for a Background node from a view showing the Background node itself (you are trying to pick a color for a node from its own output).

Another issue that you need to be aware of is which eye you are picking. To avoid problems, it’s a good idea to always pick from the left eye. The reason is that the Disparity channels for the left and right eyes are different, and when you pick from a horizontal/vertical stereo stack, Fusion has no way of knowing whether you picked the Disparity value from the left or right eye.

The above are not hard and fast rules; rather, they are guidelines to prevent foot shootings. If you understood the above reasoning fully, you’ll realize there are exceptions, like picking disparity from the left output of DisparityToZ and Z from the left/right output of ZToDisparity, where everything is okay.

Vector and Disparity Channels

The Vector and BackVector channels store the forward and reverse optical flow.

The Vector channel might be better named “forward vector” or “forward flow,” since the name “Vector” to describe a channel is “not technically correct,” as the more mathematically-inclined user might recognize that all the channels except the scalar channels Z/ID are technically “vector” channels. A frames Vector aux channel will store the flow forward from the current frame to the next frame in the sequence, and the BackVector aux channel will store the flow backward from the current frame to the previous frame. If either the previous or next frames do not exist (either not on disk or the global range of a Loader does not allow OpticalFlow to access them), Fusion will fill the corresponding channels with zeros (transparent black).

The Disparity channel stores the displacement vectors that match pixels in one eye to the other eye. The left image’s Disparity channel will contain vectors that map left > right and the right image’s Disparity channel will contain vectors that map right > left.

For example:

\[(x_{\text{left}}, y_{\text{left}}) + (D_{\text{left}}, x, D_{\text{left}}, y) \rightarrow (x_{\text{right}}, y_{\text{right}}) \quad (x_{\text{right}}, y_{\text{right}}) + (D_{\text{right}}, x, D_{\text{right}}, y) \rightarrow (x_{\text{left}}, y_{\text{left}})\]

You would expect for non-occluded pixels that \(D_{\text{left}} = -D_{\text{right}}\), although due to the disparity generation algorithm, this is only an approximate equality. Note that Disparity stores both X and Y values because rarely are left/right images perfectly registered in Y, even when taken through a carefully set up camera rig.

Disparity and Optical Flow values are stored as un-normalized pixel shifts. In particular, note that this breaks from Fusion’s resolution-independent convention. After much consideration, this convention was chosen so the user wouldn’t have to worry about rescaling the Disparity/Flow values when cropping an image or working out scale factors when importing/exporting these channels to other applications. Because the Flow and Disparity channels store things in pixel shifts, this can cause problems with Proxy and AutoProxy. The convention that Fusion follows is that, for proxied images, these channels store unscaled pixel shifts valid for the full-sized image. So if you wish to access the disparity values in a script or via a probe, you need to remember to always scale them by \((\text{image. Width}/\text{image. OriginalWidth, image. Height}/\text{image. OriginalHeight})\).

When using Vector and BackVector aux channels, remember that all nodes expect these aux channels to be filled with the flow between sequential frames.
More precisely, if you have sequence of three frames A, B, C, then:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>Vector will contain the flow B&gt;C</td>
</tr>
<tr>
<td>B</td>
<td>BackVector will contain the flow B&gt;A</td>
</tr>
<tr>
<td>A</td>
<td>Vector will contain the flow A&gt;B</td>
</tr>
<tr>
<td>A</td>
<td>BackVector is written with zeros as there is no frame before A</td>
</tr>
<tr>
<td>C</td>
<td>Vector is written with zeros as there is no frame D to flow C&gt;D</td>
</tr>
<tr>
<td>C</td>
<td>BackVector will contain the flow C&gt;B</td>
</tr>
</tbody>
</table>

When working with these channels, it is the user’s responsibility to follow these rules (or for clever users to abandon them). Nodes like TimeStretcher will not function correctly since they still expect the channels to contain flow forward/back by 1 frame.

**NOTE:** Currently DoD/RoI is not supported for all Fusion nodes.
Fusion
Page Effects
This chapter covers, in great detail, the nodes used for creating 3D composites. The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

**Contents**

<table>
<thead>
<tr>
<th>Node Name</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alembic Mesh 3D [ABC]</td>
<td>1619</td>
</tr>
<tr>
<td>Bender 3D [3BN]</td>
<td>1622</td>
</tr>
<tr>
<td>Camera 3D [3CM]</td>
<td>1624</td>
</tr>
<tr>
<td>Cube 3D [3CB]</td>
<td>1633</td>
</tr>
<tr>
<td>Custom Vertex 3D [3CV]</td>
<td>1635</td>
</tr>
<tr>
<td>Displace 3D [3DI]</td>
<td>1640</td>
</tr>
<tr>
<td>Duplicate 3D [3DP]</td>
<td>1642</td>
</tr>
<tr>
<td>FBX Exporter 3D [FBX]</td>
<td>1647</td>
</tr>
<tr>
<td>FBX Mesh 3D [FBX]</td>
<td>1650</td>
</tr>
<tr>
<td>Fog 3D [3FO]</td>
<td>1652</td>
</tr>
<tr>
<td>Image Plane 3D [3IM]</td>
<td>1655</td>
</tr>
<tr>
<td>Locator 3D [3LO]</td>
<td>1657</td>
</tr>
<tr>
<td>Merge 3D [3MG]</td>
<td>1659</td>
</tr>
<tr>
<td>Override 3D [3OV]</td>
<td>1661</td>
</tr>
<tr>
<td>Point Cloud 3D [3PC]</td>
<td>1663</td>
</tr>
<tr>
<td>Projector 3D [3PJ]</td>
<td>1667</td>
</tr>
<tr>
<td>Render 3D [3RN]</td>
<td>1671</td>
</tr>
<tr>
<td>Replace Material 3D [3RPL]</td>
<td>1680</td>
</tr>
<tr>
<td>Replace Normals 3D [3RPN]</td>
<td>1682</td>
</tr>
<tr>
<td>Replicate 3D [3REP]</td>
<td>1684</td>
</tr>
<tr>
<td>Ribbon 3D [3RI]</td>
<td>1690</td>
</tr>
<tr>
<td>Shape 3D [3SH]</td>
<td>1692</td>
</tr>
<tr>
<td>Soft Clip [3SC]</td>
<td>1695</td>
</tr>
<tr>
<td>Spherical Camera [3SC]</td>
<td>1697</td>
</tr>
<tr>
<td>Text 3D [3TXT]</td>
<td>1700</td>
</tr>
<tr>
<td>Transform 3D [3XF]</td>
<td>1709</td>
</tr>
<tr>
<td>Triangulate 3D [3TRI]</td>
<td>1712</td>
</tr>
<tr>
<td>UV Map 3D [3UV]</td>
<td>1713</td>
</tr>
<tr>
<td>Weld 3D [3WE]</td>
<td>1716</td>
</tr>
<tr>
<td>Modifier</td>
<td>1719</td>
</tr>
<tr>
<td>The Common Controls</td>
<td>1720</td>
</tr>
</tbody>
</table>
Alembic Mesh 3D [ABC]

The Alembic Mesh 3D node

Alembic Mesh Node Introduction

At times, you may need to import 3D geometry from applications like Blender, Cinema4D, or Maya. One of the formats you can use for importing 3D geometry is the Alembic file format. This file type is a 3D scene interchange format that contains baked animation with its geometry. In other words, it eliminates the animation calculation times by embedding fixed, uneditable animation with 3D geometry. The animation is typically embedded using a point cache, which saves the dynamic data such as velocity after it has been calculated. Alembic objects can contain mesh geometry, cameras, points, UVs, normals, and baked animation.

You can import Alembic files (.abc) into Fusion in two ways:
- Choose File > Import > Alembic Scene in Fusion or Fusion > Import > Alembic Scene in DaVinci Resolve’s Fusion page.
- Add an AlembicMesh3D node to the Node Editor.

The first method is the preferred method; both Alembic and FBX nodes by themselves import the entire model as one object. However, the Import menu breaks down the model, lights, camera, and animation into a string of individual nodes. This makes it easy to edit and modify and use subsections of the imported Alembic mesh. Also, transforms in the file are read into Fusion splines and into the Transform 3D nodes, which get saved with the comp. Later, when reloading the comp, the transforms are loaded from the comp and not the Alembic file. Fusion handles the meshes differently, always reloading them from the Alembic file.

Arbitrary user data varies depending on the software creating the Alembic file, and therefore this type of metadata is mostly ignored.

Alembic Import Dialog

An Alembic Import dialog is displayed once you select the file to import.
The top half of the Import dialog displays information about the selected file including the name of the plug-in/application that created the Alembic file, the version of the Alembic software developer kit used during the export, the duration of the animation in seconds, if available, and the frame rate(s) in the file.

Various objects and attributes can be imported by selecting the checkboxes in the Import section.

- **Hierarchy:** When enabled, the full parenting hierarchy is recreated in Fusion using multiple Transform 3D nodes. When disabled, the transforms in the Alembic file are flattened down into the cameras and meshes. The flattening results in several meshes/cameras connected to a single Merge node in Fusion. It is best to have this disabled when the file includes animation. If enabled, the many rigs used to move objects in a scene will result in an equally large number of nodes in Fusion, so flattening will reduce the number of nodes in your node tree.

- **Orphaned Transforms:** When the hierarchy option is enabled, an Orphaned Transforms setting is displayed. Activating this Orphan Transforms setting imports transforms that parent a mesh or camera. For example, if you have a skeleton and associated mesh model, the model is imported as an Alembic mesh, and the skeleton as a node tree of Merge3Ds. If this is disabled, the Merge3Ds are not created.

- **Cameras:** When enabled, importing a file includes cameras along with Aperture, Angles of View, Plane of Focus, as well as Near and Far clipping plane settings. The resolution Gate Fit may be imported depending on whether the application used to export the file correctly tagged the resolution Gate Fit metadata. If your camera does not import successfully, check the setting for the Camera3D Resolution Gate Fit. Note that 3D Stereoscopic information is not imported.

- **InverseTransform:** Imports the Inverse Transform (World to Model) for cameras.

- **Points:** Alembic files support a Points type. This is a collection of 3D points with position information. Some 3D software exports particles as points. However, keep in mind that while position is included, the direction and orientation of the particles are lost.

- **Meshes:** This setting determines whether importing includes 3D models from the Alembic file. If it is enabled, options to include UVs and normals are displayed.

**Animation**

This section includes one option for the Resampling rate. When exporting an Alembic animation, it is saved to disk using frames per second (fps). When importing Alembic data into Fusion, the fps are detected and entered into the Resample Rate field unless you have changed it previously in the current comp. Ideally, you should maintain the exported frame rate as the resample rate, so your samples match up with the original. The Detected Sampling Rates information at the top of the dialog can give an idea of what to pick if you are unsure. However, using this field, you can change the frame rate to create effects like slow motion.

Not all objects and properties in a 3D scene have an agreed upon universal convention in the Alembic file format. That being the case, Lights, Materials, Curves, Multiple UVs, and Velocities are not currently supported when you import Alembic files.

Since the FBX file format does support materials and lights, we recommend the use of FBX for lights, cameras, and materials. Use Alembic for meshes only.

**Inputs**

The AlembicMesh3D node has two inputs in the Node Editor. Both are optional since the node is designed to use the imported mesh.

- **SceneInput:** The orange input can be used to connect an additional 3D scene or model. The imported Alembic objects combine with the other 3D geometry.

- **MaterialInput:** The optional green input is used to apply a material to the geometry by connecting a 2D bitmap image. It applies the connected image to the surface of the geometry in the scene.
Basic Node Setup

The AlembicMesh3D node is designed to be part of a larger 3D scene. Typically, when imported, a 3D geometry model is represented by one node, and any transforms are in another node. The nodes imported as part of the Alembic file connect into a Merge 3D node along with a camera, lights, and other elements that may be required for the scene.

Inspector

Controls Tab

The first tab in the Inspector is the Controls tab. It includes a series of unique controls specific to the Alembic Mesh 3D node as well as six groupings of controls that are common to most 3D nodes. The “Common Controls” section at the end of this chapter includes detailed descriptions of the common controls.

Below are descriptions of the Alembic Mesh 3D specific controls.

Filename

The complete file path of the imported Alembic file is displayed here. This field allows you to change or update the file linked to this node.
**Object Name**

This text field shows the name of the imported Alembic mesh, which is also used to rename the Alembic Mesh 3D node in the Node Editor.

When importing with the Alembic Mesh 3D node, if this text field is blank, the entire contents of the Alembic geometry are imported as a single mesh. When importing geometry using File > Import > Alembic Scene, this field is set by Fusion.

**Wireframe**

Enabling this option causes the mesh to display only the wireframe for the object in the viewer. When enabled, there is a second option for wireframe anti-aliasing. You can also render these wireframes out to a file if the Renderer 3D node has the OpenGL render type selected.

**Common Controls**

**Controls, Materials, Transform, and Settings Tabs**

The controls for Visibility, Lighting, Matte, Blend Mode, Normals/Tangents, and Object ID in the Controls tab are common in many 3D nodes. The Materials tab, Transforms tab and Settings tab in the Inspector are also duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

---

**Bender 3D [3BN]**

![Bender 3D node](image)

**Bender 3D Introduction**

The Bender 3D node is used to bend, taper, twist, or shear 3D geometry based on the geometry’s bounding box. It works by connecting any 3D scene or object to the orange input on the Bender 3D node, and then adjusting the controls in the Inspector. Only the geometry in the scene is modified. Any lights, cameras, or materials are passed through unaffected.

The Bender node does not produce new vertices in the geometry; it only alters existing vertices in the geometry. So, when applying the Bender 3D node to primitives, like the Shape 3D, or Text 3D nodes, increase the Subdivision setting in the primitive’s node to get a higher-quality result.

**Inputs**

The following inputs appear on the Bender 3D node in the Node Editor.

- **SceneInput**: The orange scene input is the required input for the Bender 3D node. You use this input to connect another node that creates or contains a 3D scene or object.

**Basic Node Setup**

The Bender 3D node works by connecting a 3D node that contains geometry, like an image plane 3D, Shape 3D or Text 3D. The element you connect to the Bender 3D node will be distorted based on the controls in the Inspector. The Bender 3D node is designed to be part of a larger 3D scene, with the output typically connecting into a Merge 3D.
Inspector

Controls Tab

The first tab in the Inspector is the Controls tab. It includes all the controls for the Bender 3D node.

Bender Type

The Bender Type menu is used to select the type of deformation to apply to the geometry. There are four modes available: Bend, Taper, Twist, and Shear.

Amount

Adjusting the Amount slider changes the strength of the deformation.

Axis

The Axis control determines the axis along which the deformation is applied. It has a different meaning depending on the type of deformation. For example, when bending, this selects the elbow in conjunction with the Angle control. In other cases, the deform is applied around the specified axis.

Angle

The Angle thumbwheel control determines what direction about the axis a bend or shear is applied. It is not visible for taper or twist deformations.
Range
The Range control can be used to limit the effect of a deformation to a small portion of the geometry. The Range control is not available when the Bender Type is set to Shear.

Group Objects
If the input of the Bender 3D node contains multiple 3D objects, either through a Merge 3D or strung together, the Group Objects checkbox treats all the objects in the input scene as a single object, and the common center is used to deform the objects, instead of deforming each component object individually.

Common Controls

Settings
The Settings tab in the Inspector is common to all 3D nodes. This common tab is described in detail at the end of this chapter in “The Common Controls” section.

Camera 3D [3CM]

Camera 3D Node Introduction
The Camera 3D node generates a virtual camera for viewing the 3D environment. It closely emulates the settings used in real cameras to make matching live-action or 3D-rendered elements as seamless as possible. Adding any cameras to a 3D composite allows you to frame the elements in a composite how you want and animate the camera during a scene to create moving camera shots.

Camera Projection
The Camera 3D node can also be used to perform Camera Projection by projecting a 2D image through the camera into 3D space. Projecting a 2D image can be done as a simple Image Plane aligned with the camera, or as an actual projection, similar to the behavior of the Projector 3D node, with the added advantage of being aligned precisely with the camera. The Image Plane, Projection, and Materials tabs do not appear until you connect a 2D image to the magenta image input on the Camera 3D node in the Node Editor.

Stereoscopic
The Camera node has built-in stereoscopic features. They offer control over eye separation and convergence distance. The camera for the right eye can be replaced using a separate camera node connected to the green left/right stereo camera input. Additionally, the plane of focus control for depth of field rendering is also available here.

If you add a camera by dragging the camera icon from the toolbar onto the 3D view, it automatically connects to the Merge 3D you are viewing. Also, the current viewer is set to look through the new camera.

Alternatively, it is possible to copy the current viewer to a camera (or spotlight or any other object) by selecting the Copy PoV To option in the viewer’s contextual menu, under the Camera submenu.
**Inputs**

There are three optional inputs on the Camera 3D node in the Node Editor.

- **SceneInput:** The orange input is used to connect a 3D scene or object. When connected, the geometry links to the camera’s field of view. It acts similarly to an image attached to the Image Plane input. If the camera’s Projection tab has projection enabled, the image attached to the orange image input projects on to the geometry.

- **ImageInput:** The optional magenta input is used to connect a 2D image. When camera projection is enabled, the image can be used as a texture. Alternatively, when the camera’s image plane controls are used, the parented planar geometry is linked to the camera’s field of view.

- **RightStereoCamera:** The green input should be connected to another Camera 3D node when creating 3D stereoscopic effects. It is used to override the internal camera used for the right eye in stereoscopic renders and viewers.

**Basic Node Setup**

The output of a camera 3D node should be connected to a Merge 3D node. You then view the Merge 3D node and select the camera from the viewer’s right-click menu or by right-clicking over the axis label in the viewer.

Displaying a camera node directly in the viewer shows only an empty scene; there is nothing for the camera to see. To view the scene through the camera, view the Merge 3D node where the camera is connected, or any node downstream of that Merge 3D. Then right-click on the viewer and select Camera > [Camera name] from the contextual menu. Right-clicking on the axis label found in the lower corner of each 3D viewer also displays the Camera submenu.

The aspect of the viewer may be different from the aspect of the camera, so the camera view may not match the actual boundaries of the image rendered by the Renderer 3D node. Guides can be enabled to represent the portion of the view that the camera sees and assist you in framing the shot. Right-click on the viewer and select an option from the Guides > Frame Aspect submenu. The default option uses the format enabled in the Composition > Frame Format preferences. To toggle the guides on or off, select Guides > Show Guides from the viewers’ contextual menu, or use the Command-G (macOS) or Ctrl-G (Windows) keyboard shortcut when the viewer is active.
Inspector

The Camera3D Inspector includes six tabs along the top. The first tab, called the Controls tab, contains some of the most fundamental camera settings, including the camera's clipping plains, field of view, focal length, and stereoscopic properties. Some tabs are not displayed until a required connection is made to the Camera 3D node.

**Projection Type**

The Projection Type menu is used to select between Perspective and Orthographic cameras. Generally, real-world cameras are perspective cameras. An orthographic camera uses parallel orthographic projection, a technique where the view plane is perpendicular to the viewing direction. This produces a parallel camera output that is undistorted by perspective.

Orthographic cameras present controls only for the near and far clipping planes, and a control to set the viewing scale.
Near/Far Clip
The clipping planes are used to limit what geometry in a scene is rendered based on an object's distance from the camera's focal point. Clipping planes ensure objects that are extremely close to the camera, as well as objects that are too far away to be useful, are excluded from the final rendering.

The default perspective camera ignores this setting unless the Adaptive Near/Far Clip checkbox located under the Near/Far Clip control is disabled.

The clip values use units, so a far clipping plane of 20 means that any object more than 20 units from the camera is invisible to the camera. A near clipping plane of 0.1 means that any object closer than 0.1 units is also invisible.

NOTE: A smaller range between the near and far clipping planes allows greater accuracy in all depth calculations. If a scene begins to render strange artifacts on distant objects, try increasing the distance for the Near Clip plane.

Adaptive Near/Far Clip
When selected, the renderer automatically adjusts the camera's near/far clipping plane to match the extents of the scene. This setting overrides the values of the Near and Far clip range controls described above. This option is not available for orthographic cameras.

Viewing Volume Size
When the Projection Type is set to Orthographic, the viewing volume size adjustment appears. It determines the size of the box that makes up the camera's field of view.

The Z-distance of an orthographic camera from the objects it sees does not affect the scale of those objects, only the viewing size does.

Angle of View Type
Use the Angle of View Type buttons to choose how the camera's angle of view is measured. Some applications use vertical measurements, some use horizontal, and others use diagonal measurements. Changing the Angle of View type causes the Angle of View control below to recalculate.

Angle of View
Angle of View defines the area of the scene that can be viewed through the camera. Generally, the human eye can see more of a scene than a camera, and various lenses record different degrees of the total image. A large value produces a wider angle of view, and a smaller value produces a narrower, or more tightly focused, angle of view.

Just as in a real-world camera, the angle of view and focal length controls are directly related. Smaller focal lengths produce a wider angle of view, so changing one control automatically changes the other to match.

Focal Length
In the real world, a lens' Focal Length is the distance from the center of the lens to the film plane. The shorter the focal length, the closer the focal plane is to the back of the lens. The focal length is measured in millimeters. The angle of view and focal length controls are directly related. Smaller focal lengths produce a wider angle of view, so changing one control automatically changes the other to match.

The relationship between focal length and angle of view is angle = 2 * arctan[aperture / 2 / focal_length].

Use the vertical aperture size to get the vertical angle of view and the horizontal aperture size to get the horizontal angle of view.
**Plane of Focus (For Depth of Field)**

Like a focal point on a real-world camera, this setting defines the distance from the camera to an object. It is used by the OpenGL renderer in the Renderer 3D node to calculate depth of field.

**Stereo**

The Stereo section includes options for setting up 3D stereoscopic cameras. 3D stereoscopic composites work by capturing two slightly different views, displayed separately to the left and right eyes. The mode menu determines if the current camera is a stereoscopic setup or a mono camera. When set to the default mono setting, the camera views the scene as a traditional 2D film camera. Three other options in the mode menu determine the method used for 3D stereoscopic cameras.

**Toe In**

In a toe-in setup, both cameras are rotating in on a single focal point. Though the result is stereoscopic, the vertical parallax introduced by this method can cause discomfort by the audience. Toe-in stereoscopic works for convergence around the center of the images but exhibits keystoning, or image separation, to the left and right edges. This setup is can be used when the focus point and the convergence point need to be the same. It is also used in cases where it is the only way to match a live-action camera rig.

**Off Axis**

Regarded as the correct way to create stereo pairs, this is the default method in Fusion. Off Axis introduces no vertical parallax, thus creating stereo images with less eye strain. Sometimes called a skewed-frustum setup, this is akin to a lens shift in the real world. Instead of rotating the two cameras inward as in a toe-in setup, Off Axis shifts the lenses inward.
Parallel

The cameras are shifted parallel to each other. Since this is a purely parallel shift, there is no Convergence Distance control that limits your control over placing objects in front of or behind the screen. However, Parallel introduces no vertical parallax, thus creating less strain on the eyes.

Rig Attached To

This drop-down menu allows you to control which camera is used to transform the stereoscopic setup. Based on this menu, transform controls appear in the viewer either on the right camera, left camera, or between the two cameras. The ability to switch the transform controls through rigging can assist in matching the animation path to a camera crane or other live-action camera motion. The Center option places the transform controls between the two cameras and moves each evenly as the separation and convergence are adjusted. Left puts the transform controls on the left camera, and the right camera moves as the separation and convergence are adjusted. Right puts the transform controls on the right camera, and the left camera moves as adjustments are made to separation and convergence.

Eye Separation

Eye Separation defines the distance between both stereo cameras. Setting Eye Separation to a value larger than 0 shows controls for each camera in the viewer when this node is selected. Note that there is no Convergence Distance control in Parallel mode.

Convergence Distance

This control sets the stereoscopic convergence distance, defined as a point located along the Z-axis of the camera that determines where both left- and right-eye cameras converge. The Convergence Distance controls are only available when setting the Mode menu to Toe-In or Off Axis.

Film Back

Film Gate

The size of the film gate represents the dimensions of the aperture. Instead of setting the aperture’s width and height, you can choose it using the list of preset camera types in the Film Gate menu. Selecting one of the options automatically sets the aperture width and aperture height to match.

Aperture Width/Height

The Aperture Width and Height sliders control the dimensions of the camera’s aperture or the portion of the camera that lets light in on a real-world camera. In video and film cameras, the aperture is the mask opening that defines the area of each frame exposed. The Aperture control uses inches as its unit of measurement.

Resolution Gate Fit

Determines how the film gate is fitted within the resolution gate. This only has an effect when the aspect of the film gate is not the same aspect as the output image.
NOTE: This setting corresponds to Maya’s Resolution Gate. The modes Overscan, Horizontal, Vertical, and Fill correspond to Inside, Width, Height, and Outside.

- **Inside**: The image source defined by the film gate is scaled uniformly until one of its dimensions (X or Y) fits the inside dimensions of the resolution gate mask. Depending on the relative dimensions of image source and mask background, either the image source’s width or height may be cropped to fit the dimension of the mask.

- **Width**: The image source defined by the film gate is scaled uniformly until its width (X) fits the width of the resolution gate mask. Depending on the relative dimensions of image source and mask, the image source’s Y-dimension might not fit the mask’s Y-dimension, resulting in either cropping of the image source in Y or the image source not covering the mask’s height entirely.

- **Height**: The image source defined by the film gate is scaled uniformly until its height (Y) fits the height of the resolution gate mask. Depending on the relative dimensions of image source and mask, the image source’s X-dimension might not fit the mask’s X-dimension, resulting in either cropping of the image source in X or the image source not covering the mask’s width entirely.

- **Outside**: The image source defined by the film gate is scaled uniformly until one of its dimensions (X or Y) fits the outside dimensions of the resolution gate mask. Depending on the relative dimensions of image source and mask, either the image source’s width or height may be cropped or not fit the dimension of the mask.

- **Stretch**: The image source defined by the film gate is stretched in X and Y to accommodate the full dimensions of the generated resolution gate mask. This might lead to visible distortions of the image source.

**Control Visibility**

This section allows you to selectively activate the onscreen controls that are displayed along with the camera.

- **Show View Controls**: Displays or hides all camera onscreen controls in the viewers.
- **Frustum**: Displays the actual viewing cone of the camera.
- **View Vector**: Displays a white line inside the viewing cone, which can be used to determine the shift when in Parallel mode.
- **Near Clip**: The Near clipping plane. This plane can be subdivided for better visibility.
- **Far Clip**: The Far clipping plane. This plane can be subdivided for better visibility.
- **Focal Plane**: The plane based on the Plane of Focus slider explained in the Controls tab above. This plane can be subdivided for better visibility.
- **Convergence Distance**: The point of convergence when using Stereo mode. This plane can be subdivided for better visibility.

**Import Camera**

The Import Camera button displays a dialog to import a camera from another application.

It supports the following file types:

<table>
<thead>
<tr>
<th>File Type</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>LightWave Scene</td>
<td>.lws</td>
</tr>
<tr>
<td>Max Scene</td>
<td>.ase</td>
</tr>
<tr>
<td>Maya Ascii Scene</td>
<td>.ma</td>
</tr>
<tr>
<td>dotXSI</td>
<td>.xsi</td>
</tr>
</tbody>
</table>
NOTE: FBX cameras can be imported using DaVinci Resolve’s Fusion > Import > FBX Scene menu or File > Import > FBX Scene in Fusion Studio.

Image Tab
When a 2D image is connected to the magenta image input on the Camera3D node, an Image tab is created at the top of the inspector. The connected image is always oriented so it fills the camera’s field of view.

Camera 3D image plane tab

Except for the controls listed below, the options in this tab are identical to those commonly found in other 3D nodes. For more detail on visibility, lighting, matte, blend mode, normals/tangents, and Object ID, see “The Common Controls” section at the end of this chapter.

Enable Image Plane
Use this checkbox to enable or disable the usage of the Image Plane.

Fill Method
This menu configures how to scale the image plane if the camera has a different aspect ratio.

- **Inside**: The image plane is scaled uniformly until one of its dimensions (X or Y) fits the inside dimensions of the resolution gate mask. Depending on the relative dimensions of image source and mask background, either the image source’s width or height may be cropped to fit the dimensions of the mask.

- **Width**: The image plane is scaled uniformly until its width (X) fits the width of the mask. Depending on the relative dimensions of image source and the resolution gate mask, the image source’s Y-dimension might not fit the mask’s Y-dimension, resulting in either cropping of the image source in Y or the image source not covering the mask’s height entirely.

- **Height**: The image plane is scaled uniformly until its height (Y) fits the height of the mask. Depending on the relative dimensions of image source and the resolution gate mask, the image source’s X-dimension might not fit the mask’s X-dimension, resulting in either cropping of the image source in X or the image source not covering the mask’s width entirely.

- **Outside**: The image plane is scaled uniformly until one of its dimensions (X or Y) fits the outside dimensions of the resolution gate mask. Depending on the relative dimensions of image source and mask, either the image source’s width or height may be cropped or not fit the respective dimension of the mask.

- **Depth**: The Depth slider controls the image plane’s distance from the camera.
NOTE: The Camera Z position has no effect on the image plane’s distance from the camera.

Materials Tab
The options presented in the Materials tab are identical to those commonly found in other 3D nodes. For more detail on Diffuse, Specular, Transmittance, and Martial ID controls, see the “Common Controls” section at the end of this chapter.

Projection Tab
When a 2D image is connected to the camera node, a fourth projection tab is displayed at the top of the Inspector. Using this Projection tab, it is possible to project the image into the scene. A projection is different from an image plane in that the projection falls onto the geometry in the scene exactly as if there were a physical projector present in the scene. The image is projected as light, which means the Renderer 3D node must be set to enable lighting for the projection to be visible.

Enable Camera Projection
Select this checkbox to enable projection of the 2D image connected to the magenta input on the Camera node.

Projection Fit Method
This menu can be used to select the method used to match the aspect of the projected image to the camera’s field of view.

Projection Mode
- **Light**: Defines the projection as a spotlight.
- **Ambient Light**: Defines the projection as an ambient light.
- **Texture**: Allows a projection that can be relighted using other lights. Using this setting requires a Catcher node connected to the applicable inputs of the specific material.
Common Controls

Transform and Settings Tabs
The options presented in the Transform and Settings tabs are commonly found in other 3D nodes. For more detail on the controls found in these tabs, see “The Common Controls” section at the end of this chapter.

Tips for Camera 3D

Camera Projection: When importing a camera from a 3D application that is also used as a projector, make sure that the Fit Resolution Gate options on the Controls tab as well as the Projection tab are in sync. Only the first one automatically sets to what the 3D app was using. The latter might have to be adjusted manually.

Image Plane: The camera’s image plane isn’t just a virtual guide for you in the viewers. It’s actual geometry that you can also project onto. To use a different image on the image plane, you need to insert a Replace Material node after your Camera node.

Parallel Stereo: There are three ways you can achieve real Parallel Stereo mode:
- Connect an additional external (right) camera to the green Right Stereo Camera input of your camera.
- Create separate left and right cameras.
- When using Toe-In or Off Axis, set the Convergence Distance slider to a very large value of 999999999.

Rendering Overscan: If you want to render an image with overscan, you also must modify your scene’s Camera3D. Since overscan settings aren’t exported along with camera data from 3D applications, this is also necessary for cameras you’ve imported via .fbx or .ma files. The solution is to increase the film back’s width and height by the factor necessary to account for extra pixels on each side.

Cube 3D [3CB]

The Cube 3D node

Cube 3D Node Introduction
The Cube 3D node is a basic primitive geometry type capable of generating a simple cube. The node also provides six additional image inputs that can be used to map a texture onto the six faces of the cube. Cubes are often used as shadow casting objects and for environment maps. For other basic primitives, see the Shape 3D node in this chapter.

Inputs
The following are optional inputs that appear on the Cube3D node in the Node Editor:
- **SceneInput:** The orange scene input is used to connect another node that creates or contains a 3D scene or object. The additional geometry gets added to the Cube3D.

- **NameMaterialInput:** These six inputs are used to define the materials applied to the six faces of the cube. You can connect either a 2D image or a 3D material to these inputs. Textures or materials added to the Cube3D do not get added to any 3D objects connected to the Cube’s SceneInput.

**Basic Node Setup**

The output of a Cube 3D node typically connects to a Merge 3D node, integrating it into a larger scene. When 3D tracking, the Cube 3D is often used as a placeholder for proper geometry that is not available at the current time.

![Cube 3D node connected to a 3D scene exported from the Camera Tracker node](image)

**Inspector**

![Cube 3D controls](image)
Controls Tab
The first tab in the Inspector is the Controls tab. It includes the primary controls for determining the overall size and shape of the Cube 3D node.

Lock Width/Height/Depth
This checkbox locks the Width, Height, and Depth dimensions of the cube together. When selected, only a Size control is displayed; otherwise, separate Width, Height, and Depth sliders are shown.

Size or Width/Height/Depth
If the Lock checkbox is selected, then only the Size slider is shown; otherwise, separate sliders are displayed for Width, Height, and Depth. The Size and Width sliders are the same control renamed, so any animation applied to Size is also applied to Width when the controls are unlocked.

Subdivision Level
Use the Subdivision Level slider to set the number of subdivisions used when creating the image plane.

The 3D viewers and renderer use vertex lighting, meaning all lighting is calculated at the vertices on the 3D geometry and then interpolated from there. Therefore, the more subdivisions in the mesh, the more vertices are available to represent the lighting. For example, make a sphere and set the subdivisions to be small so it looks chunky. With lighting on, the object looks like a sphere but has some amount of fracturing resulting from the large distance between vertices. When the subdivisions are high, the vertices are closer and the lighting becomes more even. So, increasing subdivisions can be useful when working interactively with lights.

Cube Mapping
Enabling the Cube Mapping checkbox causes the cube to wrap its first texture across all six faces using a standard cubic mapping technique. This approach expects a texture laid out in the shape of a cross.

Wireframe
Enabling this checkbox causes the mesh to render only the wireframe for the object when rendering with the OpenGL renderer in the Renderer 3D node.

Common Controls

Controls, Materials, Transform, and Settings Tabs
The remaining controls for Visibility, Lighting, Matte, Blend Mode, Normals/Tangents, and Object ID are common to many 3D nodes. The same is true of the Materials, Transform, and Settings tabs. Their descriptions can be found in “The Common Controls” section at the end of this chapter.

Custom Vertex 3D [3CV]

Custom Vertex 3D Node Introduction
The Custom Vertex 3D node is an advanced custom node for 3D geometry that performs per vertex manipulations. If you have moderate experience with scripting or C++ programming, you should find the structure and terminology used by the Custom node familiar.
Using scripting math functions and lookup tables from images, you can move vertex positions on 3D geometry. Vertices can be more than just positions in 3D space. You can manipulate normals, texture coordinates, vectors, and velocity.

For example, Custom Vertex 3D can be used to make a flat plane wave like a flag, or create spiral models.

Besides providing a 3D scene input and three image inputs, the Inspector includes up to eight number fields and as many as eight XYZ position values from other controls and parameters in the node tree.

**NOTE:** Modifying the X, Y, and Z positions of a 3D object does not modify the normals/tangents. You can use a ReplaceNormals node afterward to recompute the normals/tangents.

**TIP:** Not all geometry has every attribute. For example, most Fusion geometry does not have vertex colors, with the exception of particles and some imported FBX/Alembic meshes. No geometry currently has environment coordinates, and only particles have velocities. If an attribute is not present on the input geometry, it is assumed to have a default value.

### Inputs

The Custom Vertex 3D node includes four inputs. The orange scene input is the only one of the four that is required.

- **SceneInput:** The orange scene input takes 3D geometry or a 3D scene from a 3D node output. This is the 3D scene or geometry that is manipulated by the calculations in the Custom Vertex 3D node.

- **ImageInput1, ImageInput2, ImageInput3:** The three image inputs using green, magenta, and teal colors are optional inputs that can be used for compositing.

**NOTE:** Missing attributes on the input geometry are created if the expression for an attribute is nontrivial. The values for the attributes are given as in the above point. For example, if the input geometry does not have normals, then the values of \((nx, ny, nz)\) is always \((0,0,1)\). To change this, you could use a ReplaceNormals node beforehand to generate them.

### Basic Node Setup

The object you want to manipulate connects to the orange scene input of the Custom Vertex 3D node. The output typically connects to a Merge 3D node, integrating it into a larger scene.
Inspector

Custom Vertex 3D node Vertex tab

**Vertex Tab**

Using the fields in the Vertex tab, vertex calculations can be performed on the Position, Normals, Vertex Color, Texture Coordinates, Environment Coordinates, UV Tangents, and Velocity attributes.

The vertices are defined by three XYZ Position values in world space as px, py, pz. Normals, which define as a vector the direction the vertex is pointing as nx, ny, nz.

Vertex color is the Red, Green, Blue, and Alpha color of the point as vcr, vcg, vcb, vca.

**Numbers Tab**

Custom Vertex 3D node Numbers tab

**Numbers 1-8**

Numbers are variables with a dial control that can be animated or connected to modifiers exactly as any other control might. The numbers can be used in equations on vertices at current time: n1, n2, n3, n4... or at any time: n1_at(float t), n2_at(float t), n3_at(float t), n4_at(float t), where t is the time you want. The values of these controls are available to expressions in the Setup and Intermediate tabs. They can be renamed and hidden from the viewer using the Config tab.
Points Tab

The point controls represent points in the Custom Vertex 3D tool, not the vertices. These eight point controls include 3D X,Y,Z position controls for positioning points at the current time: (p1x, p1y, p1z, p2x, p2y, p2z) or at any time: p1x_at(float t), p1y_at(float t), p1z_at(float t), p2x_at(float t), p2y_at(float t), p2z_at(float t), where t is the time you want. For example, you can use a point to define a position in 3D space to rotate the vertices around. They can be renamed and hidden from the viewer using the Config tab. They are normal positional controls and can be animated or connected to modifiers as any other node might.

LUT Tab

The Custom Vertex 3D node provides four LUT splines. A LUT is a lookup table that will return a value from the height of the LUT spline. For example, getlut1(float x), getlut2(float x),...

where x = 0 ... 1 accesses the LUT values.

The values of these controls are available to expressions in the Setup and Intermediate tabs using the getlut# function. For example, setting the R, G, B, and A expressions to getlut1(r1), getlut2(g1), getlut3(b1), and getlut4(a1) respectively, would cause the Custom Vertex 3D node to mimic the Color Curves node.

These controls can be renamed using the options in the Config tab to make their meanings more apparent, but expressions still see the values as lut1, lut2,...lut8.
Setup Tab

Custom Vertex 3D node Setup tab

Setups 1-8

Up to eight separate expressions can be calculated in the Setup tab of the Custom Vertex 3D node. The Setup expressions are evaluated once per frame, before any other calculations are performed. The results are then made available to the other expressions in the node as variables s1, s2, s3, and s4. Think of them as global setup scripts that can be referenced by the intermediate and channel scripts for each vertex.

For example, Setup scripts can be used to transform vertex from model to world space.

NOTE: Because these expressions are evaluated once per frame only and not for each pixel, it makes no sense to use per-pixel variables like X and Y or channel variables like r1, g1, b1, and so on. Allowable values include constants, variables like n1…n8, time, W and H, and so on, and functions like sin() or getr1d().

Intermediate Tab

Custom Vertex 3D Node Intermediate tab

Intermediates 1-8

An additional eight expressions can be calculated in the Intermediate tab. The Intermediate expressions are evaluated once per vertex, after the Setup expressions are evaluated. Results are available as variables i1, i2, i3, i4, i5, i6, i7, i8, which can be referenced by channel scripts. Think of them as “per vertex setup” scripts.

For example, you can run the script to produce the new vertex (i.e., new position, normal, tangent, UVs, etc.) or transform from world space back to model space.
Config Tab

Random Seed
Use this to set the seed for the rand() and rands() functions. Click the Reseed button to set the seed to a random value. This control may be needed if multiple Custom Vertex 3D nodes are required with different random results for each.

Number Controls
There are eight sets of Number controls, corresponding to the eight sliders in the Numbers tab. Disable the Show Number checkbox to hide the corresponding Number slider, or edit the Name for Number text field to change its name.

Point Controls
There are eight sets of Point controls, corresponding to the eight controls in the Points tab. Disable the Show Point checkbox to hide the corresponding Point control and its crosshair in the viewer. Similarly, edit the Name for Point text field to change the control’s name.

Common Controls

Settings Tab
The Settings tab controls are common to many 3D nodes, and their descriptions can be found in “The Common Controls” section at the end of this chapter.

Displace 3D [3DI]

Displace 3D Node Introduction
The Displace 3D node is used to displace the vertices of an object along their normals based on a reference image. The texture coordinates on the geometry are used to determine where to sample the image.

When using Displace 3D, keep in mind that it only displaces existing vertices and does not subdivide surfaces to increase detail. To obtain a more detailed displacement, increase the subdivision amount...
for the geometry that is being displaced. Note that the pixels in the displacement image may contain negative values.

**TIP:** Passing a particle system through a Displace 3D node disables the Always Face Camera option set in the pEmitter. Particles are not treated as point-like objects; each of the four particle vertices are individually displaced, which may or may not be the preferred outcome.

## Inputs

The following two inputs appear on the Displace 3D node in the Node Editor:

- **SceneInput:** The orange scene input is the required input for the Displace 3D node. You use this input to connect another node that creates or contains a 3D scene or object.

- **Input:** This green input is used to connect a 2D image that is used to displace the object connected to the Scene input. If no image is provided, this node effectively passes the scene straight through to its output. So, although not technically a required input, there isn’t much use for adding this node unless you connect this input correctly.

## Basic Node Setup

The output of a Displace 3D node typically connects to a Merge 3D node, integrating it into a larger scene. The 3D geometry you want to displace is connected to the orange input, and in this example, a Fast Noise node is used to displace the geometry.

An image on an Image Plane 3D is displaced by a Fast Noise node

## Inspector

Displace 3D controls
Controls Tab

The Displace 3D Inspector includes two tabs along the top. The primary tab, called the Controls tab, contains the dedicated Displace 3D controls.

Channel
Determines which channel of the connected input image is used to displace the geometry.

Scale and Bias
Use these sliders to scale (magnify) and bias (offset) the displacement. The bias is applied first and the scale afterward.

Camera Displacement

Point to Camera: When the Point to Camera checkbox is enabled, each vertex is displaced toward the camera instead of along its normal. One possible use of this option is for displacing a camera’s image plane. The displaced camera image plane would appear unchanged when viewed through the camera but is deformed in 3D space, allowing one to comp-in other 3D layers that correctly interact in Z.

Camera: This menu is used to select which camera in the scene is used to determine the camera displacement when the Point to Camera option is selected.

Common Controls

Settings Tab

The Settings tab controls are common to many 3D nodes, and their descriptions can be found in “The Common Controls” section at the end of this chapter.

Duplicate 3D [3DP]

The Duplicate 3D node

Duplicate 3D Node Introduction

Similar to the 2D version called the Duplicate node, the Duplicate 3D node can be used to duplicate any geometry in a scene, applying a successive transformation to each, and creating repeating patterns and complex arrays of objects. The options in the Jitter tab allow non-uniform transformations, such as random positioning or sizes.

Inputs

The Duplicate 3D node has a single input by default where you connect a 3D scene. An optional Mesh input appears based on the settings of the node.

SceneInput: The orange Scene Input is a required input. The scene or object you connect to this input is duplicated based on the settings in the Control tab of the Inspector.

MeshInput: A green optional mesh input appears when the Region’s tab Region menu is set to mesh. The mesh can be any 3D model, either generated in Fusion or imported.
Basic Node Setup

The output of a Duplicate 3D node typically connects to a Merge 3D node, integrating it into a larger scene. The 3D geometry you want duplicated, in this case a Cube 3D, is connected to the orange input.

A Cube 3D is duplicated

Inspector

Duplicate 3D controls

Controls Tab

The Controls tab includes all the parameters you can use to create, offset, and scale copies of the object connected to the scene input on the node.
Copies
Use this range control to set the number of copies made. Each copy is a copy of the last copy, so if this control is set to [0,3], the parent is copied, then the copy is copied, then the copy of the copy is copied, and so on. This allows some interesting effects when transformations are applied to each copy using the controls below.

Setting the First Copy to a value greater than 0 excludes the original object and shows only the copies.

Time Offset
Use the Time Offset slider to offset any animations that are applied to the source geometry by a set amount per copy. For example, set the value to -1.0 and use a cube set to rotate on the Y-axis as the source. The first copy shows the animation from a frame earlier; the second copy shows animation from a frame before that, etc. This can be used with great effect on textured planes—for example, where successive frames of a clip can be shown.

Transform Method

- **Linear**: When set to Linear, transforms are multiplied by the number of the copy, and the total scale, rotation, and translation are applied in turn, independent of the other copies.

- **Accumulated**: When set to Accumulated, each object copy starts at the position of the previous object and is transformed from there. The result is transformed again for the next copy.

Transform Order
With this menu, the order in which the transforms are calculated can be set. It defaults to Scale-Rotation-Transform (SRT).

Using different orders results in different positions of your final objects.

Translation
The X, Y, and Z Offset sliders set the offset position applied to each copy. An X offset of 1 would offset each copy 1 unit along the X-axis from the last copy.

Rotation
The buttons along the top of this group of rotation controls set the order in which rotations are applied to the geometry. Setting the rotation order to XYZ would apply the rotation on the X-axis first, followed by the Y-axis rotation, then the Z-axis rotation.

The three Rotation sliders set the amount of rotation applied to each copy.
Pivot
The pivot controls determine the position of the pivot point used when rotating each copy.

Scale
- **Lock**: When the Lock XYZ checkbox is selected, any adjustment to the duplicate scale is applied to all three axes simultaneously. If this checkbox is disabled, the Scale slider is replaced with individual sliders for the X, Y, and Z scales.
- **Scale**: The Scale controls tell Duplicate how much scaling to apply to each copy.

Jitter Tab
The options in the Jitter tab allow you to randomize the position, rotation, and size of all the copies created in the Controls tab.

![Duplicate 3D Jitter tab](image)

**Random Seed**
The Random Seed slider is used to generate a random starting point for the amount of jitter applied to the duplicated objects. Two Duplicate nodes with identical settings but different random seeds produce two completely different results.

**Randomize**
Click the Randomize button to auto generate a random seed value.

**Jitter Probability**
Adjusting this slider determines the percentage of copies that are affected by the jitter. A value of 1.0 means 100% of the copies are affected, while a value of 0.5 means 50% are affected.

**Time Offset**
Use the Time Offset slider to offset any animations that are applied to the source geometry by a set amount per copy. For example, set the value to –1.0 and use a cube set to rotate on the Y-axis as the source. The first copy shows the animation from a frame earlier; the second copy shows animation from a frame before that, etc. This can be used with great effect on textured planes—for example, where successive frames of a clip can be shown.
Translation Jitter
Use these three controls to adjust the amount of variation in the X, Y, and Z translation of the duplicated objects.

Rotation Jitter
Use these three controls to adjust the amount of variation in the X, Y, and Z rotation of the duplicated objects.

Pivot Jitter
Use these three controls to adjust the amount of variation in the rotational pivot center of the duplicated objects. This affects only the additional jitter rotation, not the rotation produced by the Rotation settings in the Controls tab.

Scale Jitter
Use this control to adjust the amount of variation in the scale of the duplicated objects. Disable the Lock XYZ checkbox to adjust the scale variation independently on all three axes.

Region Tab
The options in the Region tab allow you to define an area in the viewer where the copies can appear or are prevented from appearing. Like most parameters in Fusion, this area can be animated to cause the copied object to pop on and off the screen based on the region’s shape and setting.

Region Tab
The Region section includes two settings for controlling the shape of the region and the affect the region has on the duplicate objects.

- Region Mode: There are three options in the Region Mode menu. The default, labeled “Ignore region” bypasses the node entirely and causes no change to the copies of objects from how they are set in the Controls and Jitter tabs. The menu option labeled “When inside region” causes the copied objects to appear only when their position falls inside the region defined in this tab. The last menu option, “When not Inside region” causes the copied objects to appear only when their position falls outside the region defined in this tab.
- **Region**: The Region menu determines the shape of the region. The five options include cube, sphere, and rectangle primitive shapes. The mesh option allows you to connect a 3D model into the green mesh input on the node. The green input appears only after the Region menu is set to Mesh. The All setting refers to the entire scene. This allows the copies to pop on and off if the Region mode is animated. When the Region menu is set to Mesh, four other options are displayed. These are described below.

- **Winding Rule**: Using four common techniques, the Winding Rule menu determines how the mesh of polygons is determined as an area of volume and consequently how copies locate the vertices in the mesh. Complex overlapping regions of a mesh can cause an irregular fit. Trying a different technique from this menu can sometimes create a better match between the mesh and how the copies interpret the mesh shape.

- **Winding Ray Direction**: A 3D model is a mesh of vertices made up of flat polygons. When making this a volume for a region, the Winding Ray Direction is used to determine in which direction the volume of each polygon (like depth extrude) is aligned.

- **Limit by Object ID**: When a scene with multiple meshes is connected to the green Mesh input on the node, all the meshes are used as the region. Enabling this checkbox allows you to use the Object ID slider to select the ID for the mesh you want to use as the Region.

- **Object ID**: When the Limit by Object ID checkbox is enabled, this slider selects the number ID for the mesh object you want to use for the Region.

**Common Controls**

**Settings Tab**

The Settings tab controls are common to many 3D nodes, and their descriptions can be found in “The Common Controls” section at the end of this chapter.

**FBX Exporter 3D [FBX]**

**FBX Exporter Node Introduction**

The FBX Exporter node provides a method of exporting a Fusion 3D scene to the FBX scene interchange format. Each node in Fusion is a single object in the exported file. Objects, lights, and cameras use the name of the node that created them. The node can be set to export a single file for the entire scene, or to output one frame per file.

Setting the Preferences > Global > General > Auto Clip Browse option in the Fusion Studio application, or the Fusion > Fusion Settings > General > Auto Clip Browse option in DaVinci Resolve to Enabled (default), and then adding this node to a composition automatically displays a file browser allowing you to choose where to save the file.

Once you have set up the node, the FBX Exporter is used similarly to a Saver node: clicking the Render button in the toolbar renders out the file.

Besides the FBX format, this node can also export to the 3D Studio’s .3ds, Collada’s .dae, Autocad’s .dxf, and the Alias .obj formats.
Inputs
The FBX Exporter node has a single orange input.

- **Input:** The output of the 3D scene that you want to export connects to the orange input on the FBX Exporter node.

Basic Node Setup
The input to the FBX Exporter 3D node is any 3D scene you want to export. Below, the node is placed as a separate branch off of the Duplicate 3D node. Only the objects generated by the Duplicate 3D node are exported.

![An FBX Exporter 3D branched off from the Duplicate 3D node](image)

Inspector

![FBX Exporter controls](image)

Controls Tab
The Controls tab includes all the parameters you used to decide how the FBX file is created and what elements in the scene get exported.

**Filename**
This Filename field is used to display the location and file that is output by the node. You can click the Browse button to open a file browser dialog and change the location where the file is saved.
**Format**
This menu is used to set the format of the output file.
Not all features of this node are supported in all file formats. For example, the .obj format does not handle animation.

**Version**
The Version menu is used to select the available versions for the chosen format. The menu's contents change dynamically to reflect the available versions for that format. If the selected format provides only a single option, this menu is hidden.

Choosing Default for the FBX formats uses FBX2011.

**Frame Rate**
This menu sets the frame rate that is in the FBX scene.

**Scale Units By**
This slider changes the working units in the exported FBX file. Changing this can simplify workflows where the destination 3D software that you have uses a different scale.

**Geometry/Lights/Cameras**
These three checkboxes determine whether the node attempts to export the named scene element. For example, deselecting Geometry and Lights but leaving Cameras selected would output only the cameras currently in the scene.

**Render Range**
Enabling this checkbox saves the Render Range information in the export file, so other applications know the time range of the FBX scene.

**Reduce Constant Keys**
Enabling this option automatically removes keyframes if the adjacent keyframes have the same value.

**File Per Frame (No Animation)**
Enabling this option forces the node to export one file per frame, resulting in a sequence of numbered files. This disables the export of animation. Enable this checkbox to reveal the Sequence Start Frame control where you can set the first frame in the sequence to a custom value.

**Sequence Start Frame**
Enabling this checkbox displays a thumbwheel control to set a specific start frame for the number sequence applied to the rendered filenames. For example, if Global Start is set to 1 and frames 1–30 are rendered, files are normally numbered 0001–0030. If the Sequence Start frame is set to 100, the rendered output is numbered from 100–131.

**Common Controls**

**Settings Tab**
The Settings tab controls are common to many 3D nodes, and their descriptions can be found in “The Common Controls” section at the end of this chapter.
FBX Mesh 3D Node Introduction

The FBX Mesh 3D node is used to import polygonal geometry from scene files that are saved in the FilmBox (FBX) format. It is also able to import geometry from OBJ, 3DS, DAE, and DXF scene files. This provides a method for working with more complex geometry than is available using Fusion’s built-in primitives.

When importing geometry with this node, all the geometry in the FBX file is combined into one mesh with a single pivot and transformation. The FBX Mesh node ignores any animation applied to the geometry.

Alternatively, in Fusion Studio, the File > Import > FBX Scene or in DaVinci Resolve, the Fusion > Import > FBX Scene menu can be used to import an FBX scene. This option creates individual nodes for each camera, light, and mesh in the file. This menu option can also be used to preserve the animation of the objects.

Setting the Preferences > Global > General > Auto Clip Browse option in Fusion Studio, or the Fusion > Fusion Settings > General > Auto Clip Browse option in DaVinci Resolve to Enabled (default), and then adding this node to a composition automatically displays a file browser allowing you to choose the file to import.

Inputs

- **SceneInput**: The orange scene input is an optional connection if you wish to combine other 3D geometry nodes with the imported FBX file.
- **Material Input**: The green input is the material input that accepts either a 2D image or a 3D material. If a 2D image is provided, it is used as a diffuse texture map for the basic material tab in the node. If a 3D material is connected, then the basic material tab is disabled.

Basic Node Setup

The FBX Mesh 3D node can be used as a stand-alone node without any other nodes connected to it. The output is connected to a Merge 3D, integrating the FBX model into a larger scene. Below, the FBX Mesh 3D node also has a chrome material connected to its material input.
Inspector

Controls Tab

Most of the Controls tab is taken up by common controls. The FBX-specific controls included on this tab are primarily information and not adjustments.

Size
The Size slider controls the size of the FBX geometry that is imported. FBX meshes have a tendency to be much larger than Fusion’s default unit scale, so this control is useful for scaling the imported geometry to match the Fusion environment.

FBX File
This field displays the filename and file path of the currently loaded FBX mesh. Click the Browse button to open a file browser that can be used to locate a new FBX file. Despite the node’s name, this node is also able to load a variety of other formats.

<table>
<thead>
<tr>
<th>Format</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>FBX ascii</td>
<td>(*.fbx)</td>
</tr>
<tr>
<td>FBX 5.0 binary</td>
<td>(*.fbx)</td>
</tr>
</tbody>
</table>
Autocad DXF
(*.dxf)

3D Studio 3Ds
(*.3ds)

Alias OBJ
(*.obj)

Collada DAE
(*.dae)

**Object Name**
This input shows the name of the mesh from the FBX file that is being imported. If this field is blank, then the contents of the FBX geometry are imported as a single mesh. You cannot edit this field; it is set by Fusion when using the File > Import > FBX Scene menu.

**Take Name**
FBX files can contain multiple instances of an animation, called Takes. This field shows the name of the animation take to use from the FBX file. If this field is blank, then no animation is imported. You cannot edit this field; it is set by Fusion when using the File > Import > FBX Scene menu.

**Wireframe**
Enabling this checkbox causes the mesh to render only the wireframe for the object. Only the OpenGL renderer in the Renderer 3D node supports wireframe rendering.

**Common Controls**

**Controls, Materials, Transform, and Settings Tabs**
The remaining controls for Visibility, Lighting, Matte, Blend Mode, Normals/Tangents, and Object ID are common to many 3D nodes. The same is true of the Materials, Transform, and Settings tabs. Their descriptions can be found in “The Common Controls” section at the end of this chapter.

**Fog 3D [3FO]**

The Fog 3D node applies fog to the scene based on a depth cue. It is the 3D version of the Fog node in the Deep Pixel category. It is designed to work completely in 3D space and takes full advantage of anti-aliasing and depth of field effects during rendering.

The Fog 3D node essentially retextures the geometry in the scene by applying a color correction based on the object’s distance from the camera. An optional density texture image can be used to apply variation to the correction.

**Inputs**
The Fog 3D node has two inputs in the Node Editor, only one of which is required for the Fog 3D to project onto a 3D scene.
- **SceneInput**: The required orange-colored input accepts the output of a 3D scene on which the fog is “projected.”
- **DensityTexture**: This optional green-colored input accepts a 2D image. The color of the fog created by this node is multiplied by the pixels in this image. When creating the image for the density texture, keep in mind that the texture is effectively projected onto the scene from the camera.

**Basic Node Setup**

The Fog 3D node is placed after the Merge 3D node that contains the scene. Viewing the Fog node will show the fog applied to the objects in the 3D scene based on their Z position.

A Fog 3D node placed after the Merge 3D scene

**Inspector**

Fog node controls

**Controls Tab**

The Controls tab includes all the parameters you use to decide how the Fog looks and projects onto the geometry in the scene.
Enable
Use this checkbox to enable or disable parts of the node from processing. This is not the same as the red switch in the upper-left corner of the inspector. The red switch disables the tool altogether and passes the image on without any modification. The Enable checkbox is limited to the effect part of the tool. Other parts like scripts in the Settings tab still processes as normal.

Show Fog in View
By default, the fog created by this node is visible only when the scene is viewed using a camera node. When this checkbox is enabled, the fog becomes visible in the scene from all points of view.

Color
This control can be used to set the color of the fog. The color is also multiplied by the density texture image, if one is connected to the green input on the node.

Radial
By default, the fog is created based on the perpendicular distance to a plane (parallel with the near plane) passing through the eye point. When the Radial option is checked, the radial distance to the eye point is used instead of the perpendicular distance. The problem with perpendicular distance fog is that when you move the camera about, as objects on the left or right side of the frustum move into the center, they become less fogged although they remain the same distance from the eye. Radial fog fixes this. Radial fog is not always desirable, however. For example, if you are fogging an object close to the camera, like an image plane, the center of the image plane could be unfogged while the edges could be fully fogged.

Type
This control is used to determine the type of falloff applied to the fog.

- **Linear**: Defines a linear falloff for the fog.
- **Exp**: Creates an exponential nonlinear falloff.
- **Exp2**: Creates a stronger exponential falloff.

Near/Far Fog Distance
This control expresses the range of the fog in the scene as units of distance from the camera. The Near Distance determines where the fog starts, while the Far Distance sets the point where the fog has its maximum effect. Fog is cumulative, so the farther an object is from the camera, the thicker the fog should appear.

Common Controls

Settings Tab
The Settings tab controls are common to many 3D nodes, and their descriptions can be found in “The Common Controls” section at the end of this chapter.
Image Plane 3D Node Introduction

The Image Plane node produces 2D planar geometry in 3D space. The node is most commonly used to represent 2D images on “cards” in the 3D space. The aspect of the image plane is determined by the aspect of the image connected to the material input. If you do not want the aspect ratio of the image to modify the “card” geometry, then use a Shape 3D node instead.

Inputs

Of the two inputs on this node, the material input is the primary connection you use to add an image to the planar geometry created in this node.

- **SceneInput**: This orange input expects a 3D scene. As this node creates flat, planar geometry, this input is not required.
- **MaterialInput**: The green-colored material input accepts either a 2D image or a 3D material. It provides the texture and aspect ratio for the rectangle based on the connected source such as a Loader node in Fusion Studio or a MediaIn node in DaVinci Resolve. The 2D image is used as a diffuse texture map for the basic material tab in the Inspector. If a 3D material is connected, then the basic material tab is disabled.

Basic Node Setup

The Image Plane 3D node is primarily used to bring a video clip into a 3D composite. The MediaIn or Loader node is connected to the Image Plane 3D node, and the Image Plane 3D is then connected to a Merge 3D node. Viewing the Merge 3D node will show all the Image Plane 3D nodes and other elements connected to it.

Multiple Image Plane 3D nodes connected to a Merge 3D
Inspector

Controls Tab
Most of the Controls tab is taken up by common controls. The Image Plane specific controls at the top of the Inspector allow minor adjustments.

Lock Width/Height
When checked, the subdivision of the plane is applied evenly in X and Y. When unchecked, there are two sliders for individual control of the subdivisions in X and Y. This defaults to on.

Subdivision Level
Use the Subdivision Level slider to set the number of subdivisions used when creating the image plane. If the OpenGL viewer and renderer are set to Vertex lighting, the more subdivisions in the mesh, the more vertices are available to represent the lighting. So, high subdivisions can be useful when working interactively with lights.

Wireframe
Enabling this checkbox causes the mesh to render only the wireframe for the object when using the OpenGL renderer.

Common Controls

Controls, Materials, Transform, and Settings Tabs
The remaining controls for Visibility, Lighting, Matte, Blend Mode, Normals/Tangents, and Object ID are common to many 3D nodes. The same is true of the Materials, Transform, and Settings tabs. Their descriptions can be found in “The Common Controls” section at the end of this chapter.
Locator 3D [3LO]

The Locator 3D node

Locator 3D Node Introduction

The Locator 3D node’s purpose is to transform a point in 3D space to 2D coordinates that other nodes can use as part of expressions or modifiers.

When the Locator is provided with a camera and the dimensions of the output image, it transforms the coordinates of a 3D control into 2D screen space. The 2D position is exposed as a numeric output that can be connected to/from other nodes. For example, to connect the center of an ellipse to the 2D position of the Locator, right-click on the Mask center control and select Connect To > Locator 3D > Position.

Inputs

Two inputs accept 3D scenes as sources. The orange scene input is required, while the green Target input is optional.

- **SceneInput**: The required orange scene input accepts the output of a 3D scene. This scene should contain the object or point in 3D space that you want to covert to 2D coordinates.

- **Target**: The optional green target input accepts the output of a 3D scene. When provided, the transform center of the scene is used to set the position of the Locator. The transformation controls for the Locator become offsets from this position.

Basic Node Setup

The scene provided to the Locator’s input must contain the camera through which the coordinates are projected. So, the best practice is to place the Locator after the Merge that introduces the camera to the scene.

If an object is connected to the Locator node’s target input, the Locator is positioned at the object’s center, and the Transformation tab’s translation XYZ sliders function in the object’s local coordinate space instead of global scene space. This is useful for tracking an object’s position despite any additional transformations applied further downstream.

Locator 3D connected after a Merge 3D with the SpotLight as the target
Inspector

Controls Tab

Most of the controls for the locator 3D are cosmetic, dealing with how the locator appears and whether it is rendered in the final output. However, the Camera Settings are critical to getting the results you’re looking for.

Size

The Size slider is used to set the size of the Locator’s onscreen crosshair.

Color

A basic Color control is used to set the color of the Locator’s onscreen crosshair.

Matte

Enabling the Is Matte option applies a special texture to this object, causing this object to not only become invisible to the camera, but also making everything that appears directly behind the camera invisible as well. This option overrides all textures. For more information, see Chapter 86, “3D Compositing Basics” in the DaVinci Resolve Reference Manual or Chapter 25 in the Fusion Reference Manual.

- **Is Matte**: When activated, objects whose pixels fall behind the matte object’s pixels in Z do not get rendered.
- **Opaque Alpha**: Sets the Alpha value of the matte object to 1. This checkbox is visible only when the Is Matte option is enabled.
- **Infinite Z**: Sets the value in the Z-channel to infinity. This checkbox is visible only when the Is Matte option is enabled.
Sub ID
The Sub ID slider can be used to select an individual subelement of certain geometry, such as an individual character produced by a Text 3D node or a specific copy created by a Duplicate 3D node.

Make Renderable
Defines whether the Locator is rendered as a visible object by the OpenGL renderer. The software renderer is not currently capable of rendering lines and hence ignores this option.

Unseen by Camera
This checkbox control appears when the Make Renderable option is selected. If the Unseen by Camera checkbox is selected, the Locator is visible in the viewers but not rendered into the output image by the Renderer 3D node.

Camera
This drop-down control is used to select the Camera in the scene that defines the screen space used for 3D to 2D coordinate transformation.

Use Frame Format Settings
Select this checkbox to override the width, height, and pixel aspect controls, and force them to use the values defined in the composition’s Frame Format preferences instead.

Width, Height, and Pixel Aspect
In order for the Locator to generate a correct 2D transformation, it must know the dimensions and aspect of the image. These controls should be set to the same dimensions as the image produced by a renderer associated with the camera specified above. Right-clicking on these controls displays a contextual menu containing the frame formats configured in the composition’s preferences.

Common Controls

Transform and Settings tabs
The remaining Transform and Settings tabs are common to many 3D nodes. Their descriptions can be found in “The Common Controls” section at the end of this chapter.

Merge 3D [3MG]

The Merge 3D node

Merge 3D Introduction
The Merge 3D node is the primary node in Fusion that you use to combine separate 3D elements into the same 3D environment.

For example, in a scene created with an image plane, a camera, and a light, the camera would not be able to see the image plane and the light would not affect the image plane until all three objects are introduced into the same environment using the Merge 3D node.

The Merge provides the standard transformation controls found on most nodes in Fusion’s 3D suite. Unlike those nodes, changes made to the translation, rotation, or scale of the Merge affect all the objects connected to the Merge. This behavior forms the basis for all parenting in Fusion’s 3D environment.
Inputs

The Merge node displays only two inputs initially, but as each input is connected a new input appears on the node, assuring there is always one free to add a new element into the scene.

- **SceneInput[#]**: These multicolored inputs are used to connect image planes, 3D cameras, lights, entire 3D scenes, as well as other Merge 3D nodes. There is no limit to the number of inputs this node can accept. The node dynamically adds more inputs as needed, ensuring that there is always at least one input available for connection.

Basic Node Setup

The Merge 3D is the hub of a 3D composite. All elements in a 3D scene connect into a Merge 3D. Multiple Merge 3D nodes can be strung together to control lighting or for neater organization. The last Merge 3D in a string must connect to a Renderer 3D to be output as a 2D image.

![Merge 3D with a connected Image Plane, FBX Mesh object, SpotLight, and camera](image)

Inspector

![Merge 3D controls](image)

Controls Tab

The Controls tab is used only to pass through any lights connected to the Merge 3D node.

**Pass Through Lights**

When the Pass Through Lights checkbox is selected, lights are passed through the Merge into its output to affect downstream elements. Normally, the lights are not passed downstream to affect the rest of the scene. This is frequently used to ensure projections are not applied to geometry introduced later in the scene.

Common Controls

**Transform and Settings Tabs**

The remaining controls for the Transform and Settings tabs are common to most 3D nodes. Their descriptions can be found in "The Common Controls" section at the end of this chapter.
Override 3D Node Introduction

The Override node lets you change object-specific options for every object in a 3D scene simultaneously. This is useful, for example, when you wish to set every object in the input scene to render as a wireframe. Additionally, this node is the only way to set the wireframe, visibility, lighting, matte, and ID options for 3D particle systems and the Text 3D node.

Inputs

- **SceneInput**: The orange Scene input accepts the output of a Merge 3D node or any node creating a 3D scene.

Basic Node Setup

The Override 3D node is frequently used in conjunction with the Replace Material node to produce isolated passes. For example, in the node tree below, a scene branches out to an Override node that turns off the Affected by Lights property of each node, then connects to a Replace Material node that applies a Falloff shader to produce a falloff pass of the scene.

![Override 3D connected to a Replace Material node](image-url)
**Inspector**

Override 3D controls

**Controls Tab**

The function of the controls found in the Controls tab is straightforward. First, you select the option to override using the Do [Option] checkbox. That reveals a control that can be used to set the value of the option itself. The individual options are not documented here; a full description of each can be found in any geometry creation node in this chapter, such as the Image Plane, Cube, or Shape nodes.

**Do [Option]**

Enables the override for this option.

**[Option]**

If the Do [Option] checkbox is enabled, then the control for the property itself becomes visible. The control values of the properties for all upstream objects are overridden by the new value.

**Common Controls**

**Settings Tabs**

The Settings tab includes controls common to most 3D nodes. Their descriptions can be found in “The Common Controls” section at the end of this chapter.
Point Cloud 3D Node Introduction

A Point Cloud is generally many null objects created by 3D tracking or modeling software.

When produced by 3D tracking software, the points typically represent each of the patterns tracked to create the 3D camera path. These point clouds can be used to identify a ground plane and to orient other 3D elements with the tracked image. The Point Cloud 3D node creates a point cloud either by importing a file from a 3D tracking application or generating it when you use the Camera Tracker node.

**NOTE:** A null object is an invisible 3D object that has all the same transform properties of a visible 3D object.

**Inputs**

The Point Cloud has only a single input for a 3D scene.

- **SceneInput:** This orange input accepts a 3D scene.

**Basic Node Setup**

The Point Cloud 3D node is viewed and connected through a Merge 3D node, integrating it into the larger 3D scene.
Inspector

Controls Tab
The Controls tab is where you can import the point cloud from a file and controls its appearance in the viewer.

Style
The Style menu allows you to display the point cloud as cross hairs or points in the viewer.

Lock X/Y/Z
Deselect this checkbox to provide individual control over the size of the X, Y, and Z arms of the points in the cloud.

Size X/Y/Z
These sliders can be used to increase the size of the onscreen crosshairs used to represent each point.

Density
This slider defines the probability of displaying a specific point. If the value is 1, then all points are displayed. A value of 0.2 shows only every fifth point.

Color
Use the standard Color control to set the color of onscreen crosshair controls.

Import Point Cloud
The Import Point Cloud button displays a dialog to import a point cloud from another application.
Supported file types are:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias's Maya</td>
<td>.ma</td>
</tr>
<tr>
<td>3DS Max ASCII Scene Export</td>
<td>.ase</td>
</tr>
<tr>
<td>NewTek's LightWave</td>
<td>.lws</td>
</tr>
<tr>
<td>Softimage XSI's</td>
<td>.xsi</td>
</tr>
</tbody>
</table>

**Make Renderable**

Determines whether the point cloud is visible in the OpenGL viewer and in final renderings made by the OpenGL renderer. The software renderer does not currently support rendering of visible crosshairs for this node.

**Unseen by Camera**

This checkbox control appears when the Make Renderable option is selected. If the Unseen by Cameras checkbox is selected, the point cloud is visible in the viewers but not rendered into the output image by the Renderer 3D node.

**Common Controls**

**Transform and Settings Tabs**

The remaining Transform and Settings tabs are common to many 3D nodes. Their descriptions can be found in “The Common Controls” section at the end of this chapter.

**Onscreen Contextual Menu**

Frequently, one or more of the points in an imported point cloud is manually assigned to track the position of a specific feature. These points usually have names that distinguish them from the rest of the points in the cloud. To see the current name for a point, hover the mouse pointer directly over a point, and after a moment a small tooltip appears with the name of the point.

When the Point Cloud 3D node is selected, a submenu is added to the viewer’s contextual menu with several options that make it simple to locate, rename, and separate these points from the rest of the point cloud.
The contextual menu contains the following options:

- **Find:** Selecting this option from the viewer contextual menu opens a dialog to search for and select a point by name. Each point that matches the pattern is selected.

- **Rename:** Rename any point by selecting Rename from the contextual menu. Type the new name into the dialog that appears and press Return. The point now has that name, with a four-digit number added to the end. For example, the Name window is window0000, and multiple points would be window0000, window0001, and so on. Names must be valid Fusion identifiers (i.e., no spaces allowed, and the name cannot start with a number).

- **Delete:** Selecting this option deletes the currently selected points.

- **Publish:** Normally, the exact position of a point in the cloud is not exposed. To expose the position, select the points, and then select the Publish option from this contextual menu. This adds a coordinate control to the control panel for each published point that displays the point’s current location.

### Additional Toolbar and Shortcuts

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Selected Points</td>
<td>Del</td>
</tr>
<tr>
<td>Select All</td>
<td>Shift+A</td>
</tr>
<tr>
<td>Find Points</td>
<td>Shift+F</td>
</tr>
<tr>
<td>Rename Selected Points</td>
<td>F2</td>
</tr>
<tr>
<td>Create New Point</td>
<td>Shift+C</td>
</tr>
<tr>
<td>Toggle Names on None/Selected/Published/All Points</td>
<td>Shift+N</td>
</tr>
<tr>
<td>Toggle Locations on None/Selected/Published/All Points</td>
<td>Shift+L</td>
</tr>
<tr>
<td>Publish Selected Points</td>
<td>Shift+P</td>
</tr>
<tr>
<td>Unpublish Selected Points</td>
<td>Shift+U</td>
</tr>
<tr>
<td>Create a Shape at Selected Points</td>
<td>Shift+S</td>
</tr>
<tr>
<td>Create and Fit an ImagePlane to Selected Points</td>
<td>Shift+I</td>
</tr>
<tr>
<td>Create a Locator at Selected Points</td>
<td>Shift+O</td>
</tr>
</tbody>
</table>
Projector 3D Node Introduction

The Projector 3D node is used to project an image upon 3D geometry. This can be useful in many ways: texturing objects with multiple layers, applying a texture across multiple separate objects, projecting background shots from the camera's viewpoint, image-based rendering techniques, and more. The Projector node is just one of several nodes capable of projecting images and textures. Each method has advantages and disadvantages. For more information, see Chapter 86, “3D Compositing Basics,” in the DaVinci Resolve Reference Manual or Chapter 25 in the Fusion Reference Manual.

Projected textures can be allowed to “slide” across the object if the object moves relative to the Projector 3D, or, alternatively, by grouping the two with a Merge 3D so they can be moved as one and the texture remains locked to the object.

The Projector 3D node’s capabilities and restrictions are best understood if the Projector is considered to be a variant on the SpotLight node. The fact that the Projector 3D node is actually a light has several important consequences when used in Light or Ambient Light projection mode:

- Lighting must be turned on for the results of the projection to be visible.
- The light emitted from the projector is treated as diffuse/specular light. This means that it is affected by the surface normals and can cause specular highlights. If this is undesirable, set the Projector 3D to project into the Ambient Light channel.
- Enabling Shadows causes Projector 3D to cast shadows.
- Just as with other lights, the light emitted by a Projector 3D only affects objects that feed into the first Merge 3D that is downstream of the Projector 3D node in the node tree.
- Enabling Merge 3D’s Pass Through Lights checkbox allows the projection to light objects further downstream.
- The light emitted by a Projector 3D is controlled by the Lighting options settings on objects and the Receives Lighting options on materials.
- Alpha values in the projected image do not clip geometry in Light or Ambient Light mode. Use Texture mode instead.
- If two projections overlap, their light contributions are added.

To project re-lightable textures or textures for non-diffuse color channels (like Specular Intensity or Bump), use the Texture projection mode instead:

- Projections in Texture mode only strike objects that use the output of the Catcher node for all or part of the material applied to that object.
- Texture mode projections clip the geometry according to the Alpha channel of the projected image.

See the section for the Catcher node for additional details.
**Camera Projection vs. Projection 3D Node**

The Camera 3D node also provides a projection feature, and should be used when the projection is meant to match a camera, as this node has more control over aperture, film back, and clip planes. The Projector 3D node was designed to be used as a custom light in 3D scenes for layering and texturing. The projector provides better control over light intensity, color, decay, and shadows.

**Inputs**

The Projector 3D has two inputs: one for the scene you are projecting onto and another for the projected image.

- **SceneInput**: The orange scene input accepts a 3D scene. If a scene is connected to this input, then transformations applied to the spotlight also affect the rest of the scene.

- **ProjectiveImage**: The white input expects a 2D image to be used for the projection. This connection is required.

**Basic Node Setup**

As an example, the Projector 3D node below is used to project a texture (MediaIn2) onto 3D primitives as a way to create a simple 3D set. All the set elements are connected into a Merge 3D, which outputs the projected set into a larger scene with camera, lights, and other elements. As an alternative, the Projector 3D node could be inserted between the two Merge 3D nodes; however, the transform controls in the Projector 3D node would then affect the entire scene.

![Projector 3D texturing groups of shapes to construct a set](image)

**Inspector**

![Projector 3D controls](image)
Controls Tab

Enabled
When this checkbox is enabled, the projector affects the scene. Disable the checkbox to turn off the projector. This is not the same as the red switch in the upper-left corner of the Inspector. The red switch disables the tool altogether and passes the image on without any modification. The Enabled checkbox is limited to the effect part of the tool. Other parts, like scripts in the Settings tab still process as normal.

Color
The input image is multiplied by this color before being projected into the scene.

Intensity
Use this slider to set the Intensity of the projection when the Light and Ambient Light projection modes are used. In Texture mode, this option scales the Color values of the texture after multiplication by the color.

Decay Type
A projector defaults to No Falloff, meaning that its light has equal intensity on geometry, despite the distance from the projector to the geometry. To cause the intensity to fall off with distance, set the Decay type to either Linear or Quadratic modes.

Angle
The Cone Angle of the node refers to the width of the cone where the projector emits its full intensity. The larger the angle, the wider the cone angle, up to a limit of 90 degrees.

Fit Method
The Fit Method determines how the projection is fitted within the projection cone.

The first thing to know is that although this documentation may call it a “cone,” the Projector 3D and Camera 3D nodes do not project an actual cone; it’s more of a pyramid of light with its apex at the camera/projector. The Projector 3D node always projects a square pyramid of light—i.e., its X and Y angles of view are the same. The pyramid of light projected by the Camera 3D node can be non-square depending on what the Film Back is set to in the camera. The aspect of the image connected into the Projector 3D/Camera 3D does not affect the X/Y angles of the pyramid, but rather the image is scaled to fit into the pyramid based upon the fit options.

When both the aspect of the pyramid (AovY/AovX) and the aspect of the image (height * pixelAspectY)/(width * pixelAspectX) are the same, there is no need for the fit options, and in this case the fit options all do the same thing. However, when the aspect of the image and the pyramid (as determined by the Film Back settings in Camera 3D) are different, the fit options become important.

For example, Fit by Width fits the width of the image across the width of the Camera 3D pyramid. In this case, if the image has a greater aspect ratio than the aspect of the pyramid, some of the projection extends vertically outside of the pyramid.

There are five options:

- **Inside**: The image is uniformly scaled so that its largest dimension fits inside the cone. Another way to think about this is that it scales the image as big as possible subject to the restriction that the image is fully contained within the pyramid of the light. This means, for example, that nothing outside the pyramid of light ever receives any projected light.

- **Width**: The image is uniformly scaled so that its width fits inside the cone. Note that the image could still extend outside the cone in its height direction.

- **Height**: The image is uniformly scaled so that its height fits inside the cone. Note that the image could still extend outside the cone in its width direction.
Outside: The image is uniformly scaled so that its smallest dimension fits inside the cone. Another way to think about this is that it scales the image as small as possible subject to the restriction that the image covers the entire pyramid (i.e., the pyramid is fully contained within the image). This means that any pixel of any object inside the pyramid of light always gets illuminated.

Stretch: The image is non-uniformly scaled, so it exactly covers the cone of the projector.

Projection Mode

- **Light:** Projects the texture as a diffuse/specular light.
- **Ambient Light:** Uses an ambient light for the projection.
- **Texture:** When used in conjunction with the Catcher node, this mode allows re-lightable texture projections. The projection strikes only objects that use the catcher material as part of their material shaders.

One useful trick is to connect a Catcher node to the Specular Texture input on a 3D Material node (such as a Blinn). This causes any object using the Blinn material to receive the projection as part of the specular highlight. This technique can be used in any material input that uses texture maps, such as the Specular and Reflection maps.

Shadows

Since the projector is based on a spotlight, it is also capable of casting shadows using shadow maps. The controls under this reveal are used to define the size and behavior of the shadow map.

- **Enable Shadows:** The Enable Shadows checkbox should be selected if the light is to produce shadows. This defaults to selected.
- **Shadow Color:** Use this standard Color control to set the color of the shadow. This defaults to black (0, 0, 0).
- **Density:** The Shadow Density determines the transparency of the shadow. A density of 1.0 produces a completely transparent shadow, whereas lower values make the shadow transparent.
- **Shadow Map Size:** The Shadow Map Size control determines the size of the bitmap used to create the shadow map. Larger values produce more detailed shadow maps at the expense of memory and performance.
- **Shadow Map Proxy:** The Shadow Map Proxy determines the size of the shadow map used for proxy and auto proxy calculations. A value of 0.5 would use a 50% shadow map.
- **Multiplicative/Additive Bias:** Shadows are essentially textures applied to objects in the scene, so there is occasionally Z-fighting, where the portions of the object that should be receiving the shadows render over the top of the shadow instead.
- **Multiplicative and Additive Bias:** Bias works by adding a small depth offset to move the shadow away from the surface it is shadowing, eliminating the Z-fighting. Too little bias and the objects can self-shadow themselves. Too much bias and the shadow can become separated from the surface. Adjust the multiplicative bias first, then fine tune the result using the additive bias control.
- **Force All Materials Non-Transmissive:** Normally, an RGBAZ shadow map is used when rendering shadows. By enabling this option, you are forcing the renderer to use a Z-only shadow map. This can lead to significantly faster shadow rendering while using a fifth as much memory. The disadvantage is that you can no longer cast “stained-glass”-like shadows.
- **Shadow Map Sampling:** Sets the quality for sampling of the shadow map.
– **Softness**: Soft edges in shadows are produced by filtering the shadow map when it is sampled. Fusion provides three separate filtering methods that produce different effects when rendering shadows.

– **None**: Shadows have a hard edge. No filtering of the shadow map is done at all. The advantage of this method is that you only have to sample one pixel in the shadow map, so it is fast.

– **Constant**: Shadow edges have a constant softness. A filter with a constant width is used when sampling the shadow map. Adjusting the Constant Softness slider controls the size of the filter. Note that the larger you make the filter, the longer it takes to render the shadows. If the Softness is set to constant, then a Constant slider appears. It can be used to set the overall softness of the shadow.

– **Variable**: The softness of shadow edges grows the farther away the shadow receiver is from the shadow caster. The variable softness is achieved by changing the size of the filter based on the distance between the receiver and caster. When this option is selected, the Softness Falloff, Min Softness and Max Softness sliders appear.

<table>
<thead>
<tr>
<th>Softness Falloff</th>
<th>The Softness Falloff slider appears when the Softness is set to variable. This slider controls how fast the softness of shadow edges grows with distance. More precisely, it controls how fast the shadow map filter size grows based on the distance between shadow caster and receiver. Its effect is mediated by the values of the Min and Max Softness sliders.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min Softness</td>
<td>The Min Softness slider appears when the Softness is set to variable. This slider controls the Minimum Softness of the shadow. The closer the shadow is to the object casting the shadow, the sharper it is up to the limit set by this slider.</td>
</tr>
<tr>
<td>Max Softness</td>
<td>The Max Softness slider appears when the Softness is set to variable. This slider controls the Maximum Softness of the shadow. The farther the shadow is from the object casting the shadow, the softer it is up to the limit set by this slider.</td>
</tr>
</tbody>
</table>

**Common Controls**

**Transform and Settings Tabs**
The remaining Transform and Settings tabs are common to many 3D nodes. Their descriptions can be found in “The Common Controls” section at the end of this chapter.

---

**Renderer 3D [3RN]**

The Renderer 3D node

**Renderer 3D Node Introduction**
The Renderer 3D node converts the 3D environment into a 2D image using either a default perspective camera or one of the cameras found in the scene. Every 3D scene in a composition terminates with at least one Renderer 3D node. The Renderer node includes a software and OpenGL render engine to produce the resulting image. Additional render engines may also be available via third-party plug-ins.
The software render engine uses the system’s CPU only to produce the rendered images. It is usually much slower than the OpenGL render engine, but produces consistent results on all machines, making it essential for renders that involve network rendering. The Software mode is required to produce soft shadows, and generally supports all available illumination, texture, and material features.

The OpenGL render engine employs the GPU processor on the graphics card to accelerate the rendering of the 2D images. The output may vary slightly from system to system, depending on the exact graphics card installed. The graphics card driver can also affect the results from the OpenGL renderer. The OpenGL render engines speed makes it possible to provide customized supersampling and realistic 3D depth of field options. The OpenGL renderer cannot generate soft shadows. For soft shadows, the software renderer is recommended.

Like most nodes, the Renderer’s motion blur settings can be found under the Common Controls tab. Be aware that scenes containing particle systems require that the Motion Blur settings on the pRender nodes exactly match the settings on the Renderer 3D node.

Otherwise, the subframe renders conflict producing unexpected (and incorrect) results.

**NOTE:** The OpenGL renderer respects the Color Depth option in the Image tab of the Renderer 3D node. This can cause slowdowns on certain graphics cards when rendering to int16 or float32.

**Inputs**

The Renderer 3D node has two inputs on the node. The main scene input takes in the Merge 3D or other 3D nodes that need to be converted to 2D. The effect mask limits the Renderer 3D output.

- **SceneInput:** The orange scene input is a required input that accepts a 3D scene that you want to convert to 2D.

- **EffectMask:** The blue effects mask input uses a 2D image to mask the output of the node.

**Basic Node Setup**

All 3D scenes must end with a Renderer 3D node. The Renderer 3D node is used to convert a 3D scene into a 2D image. Below, the Renderer 3D node takes the output of a Merge 3D node, and renders the 3D scene into a 2D image.

Renderer 3D connected directly after a Merge 3D, rendering the 3D scene to a 2D image
Inspector

Controls Tab

Camera
The Camera menu is used to select which camera from the scene is used when rendering. The Default setting uses the first camera found in the scene. If no camera is located, the default perspective view is used instead.

Eye
The Eye menu is used to configure rendering of stereoscopic projects. The Mono option ignores the stereoscopic settings in the camera. The Left and Right options translate the camera using the stereo Separation and Convergence options defined in the camera to produce either left- or right-eye outputs. The Stacked option places the two images one on top of the other instead of side by side.

Reporting
The first two checkboxes in this section can be used to determine whether the node prints warnings and errors produced while rendering to the console. The second set of checkboxes tells the node whether it should abort rendering when a warning or error is encountered. The default for this node enables all four checkboxes.

Renderer Type
This menu lists the available render engines. Fusion provides three: the software renderer, OpenGL renderer, and the OpenGL UV render engine. Additional renderers can be added via third-party plug-ins.
All the controls found below this drop-down menu are added by the render engine. They may change depending on the options available to each renderer. So, each renderer is described in its own section below.

**Software Controls**

**Output Channels**

Besides the usual Red, Green, Blue, and Alpha channels, the software renderer can also embed the following channels into the image. Enabling additional channels consumes additional memory and processing time, so these should be used only when required.

- **RGBA**: This option tells the renderer to produce the Red, Green, Blue, and Alpha color channels of the image. These channels are required, and they cannot be disabled.

- **Z**: This option enables rendering of the Z-channel. The pixels in the Z-channel contain a value that represents the distance of each pixel from the camera. Note that the Z-channel values cannot include anti-aliasing. In pixels where multiple depths overlap, the frontmost depth value is used for this pixel.

- **Coverage**: This option enables rendering of the Coverage channel. The Coverage channel contains information about which pixels in the Z-buffer provide coverage (are overlapping with other objects). This helps nodes that use the Z-buffer to provide a small degree of anti-aliasing. The value of the pixels in this channel indicates, as a percentage, how much of the pixel is composed of the foreground object.

- **BgColor**: This option enables rendering of the BgColor channel. This channel contains the color values from objects behind the pixels described in the Coverage channel.

- **Normal**: This option enables rendering of the X, Y, and Z Normals channels. These three channels contain pixel values that indicate the orientation (direction) of each pixel in the 3D space. A color channel containing values in a range from \([-1,1]\) represents each axis.

- **TexCoord**: This option enables rendering of the U and V mapping coordinate channels. The pixels in these channels contain the texture coordinates of the pixel. Although texture coordinates are processed internally within the 3D system as three-component UVW, Fusion images store only UV components. These components are mapped into the Red and Green color channel.

- **ObjectID**: This option enables rendering of the ObjectID channel. Each object in the 3D environment can be assigned a numeric identifier when it is created. The pixels in this floating-point image channel contain the values assigned to the objects that produced the pixel. Empty pixels have an ID of 0, and the channel supports values as high as 65534. Multiple objects can share a single Object ID. This buffer is useful for extracting mattes based on the shapes of objects in the scene.

- **MaterialID**: This option enables rendering of the Material ID channel. Each material in the 3D environment can be assigned a numeric identifier when it is created. The pixels in this floating-point image channel contain the values assigned to the materials that produced the pixel. Empty pixels have an ID of 0, and the channel supports values as high as 65534. Multiple materials can share a single Material ID. This buffer is useful for extracting mattes based on a texture; for example, a mask containing all the pixels that comprise a brick texture.

**Lighting**

- **Enable Lighting**: When the Enable Lighting checkbox is selected, objects are lit by any lights in the scene. If no lights are present, all objects are black.

- **Enable Shadows**: When the Enable Shadows checkbox is selected, the renderer produces shadows, at the cost of some speed.
OpenGL Controls

Output Channels

In addition to the usual Red, Green, Blue, and Alpha channels, the OpenGL render engine can also embed the following channels into the image. Enabling additional channels consumes additional memory and processing time, so these should be used only when required.

- **RGBA**: This option tells the renderer to produce the Red, Green, Blue, and Alpha color channels of the image. These channels are required, and they cannot be disabled.

- **Z**: This option enables rendering of the Z-channel. The pixels in the Z-channel contain a value that represents the distance of each pixel from the camera. Note that the Z-channel values cannot include anti-aliasing. In pixels where multiple depths overlap, the frontmost depth value is used for this pixel.

- **Normal**: This option enables rendering of the X, Y, and Z Normals channels. These three channels contain pixel values that indicate the orientation (direction) of each pixel in the 3D space. A color channel containing values in a range from $[-1,1]$ is represented by each axis.
— **TexCoord:** This option enables rendering of the U and V mapping coordinate channels. The pixels in these channels contain the texture coordinates of the pixel. Although texture coordinates are processed internally within the 3D system as three-component UVW, Fusion images store only UV components. These components are mapped into the Red and Green color channels.

— **ObjectID:** This option enables rendering of the ObjectID channel. Each object in the 3D environment can be assigned a numeric identifier when it is created. The pixels in this floating-point image channel contain the values assigned to the objects that produced the pixel. Empty pixels have an ID of 0, and the channel supports values as high as 65534. Multiple objects can share a single Object ID. This buffer is useful for extracting mattes based on the shapes of objects in the scene.

— **MaterialID:** This option enables rendering of the Material ID channel. Each material in the 3D environment can be assigned a numeric identifier when it is created. The pixels in this floating-point image channel contain the values assigned to the materials that produced the pixel. Empty pixels have an ID of 0, and the channel supports values as high as 65534. Multiple materials can share a single Material ID. This buffer is useful for extracting mattes based on a texture—for example, a mask containing all the pixels that comprise a brick texture.

### Anti-Aliasing

Anti-aliasing can be enabled for each channel through the Channel menu. It produces an output image with higher quality anti-aliasing by brute force, rendering a much larger image, and then rescaling it down to the target resolution. Rendering a larger image in the first place, and then using a Resize node to bring the image to the desired resolution can achieve the exact same results. Using the supersampling built in to the renderer offers two distinct advantages over this method.

The rendering is not restricted by memory or image size limitations. For example, consider the steps to create a float-16 1920 x 1080 image with 16x supersampling. Using the traditional Resize node would require first rendering the image with a resolution of 30720 x 17280, and then using a Resize to scale this image back down to 1920 x 1080. Simply producing the image would require nearly 4 GB of memory. When anti-aliasing is performed on the GPU, the OpenGL renderer can use tile rendering to significantly reduce memory usage.

The GL renderer can perform the rescaling of the image directly on the GPU more quickly than the CPU can manage it. Generally, the more GPU memory the graphics card has, the faster the operation is performed.

Interactively, Fusion skips the anti-aliasing stage unless the HiQ button is selected in the Time Ruler. Final quality renders always include supersampling, if it is enabled.

Because of hardware limitations, point geometry (particles) and lines (locators) are always rendered at their original size, independent of supersampling. This means that these elements are scaled down from their original sizes, and likely appear much thinner than expected.

### Anti-Aliasing of Aux Channels in the OpenGL Renderer

The reason Fusion supplies separate anti-aliasing options for color and aux channels in the Anti-Aliasing preset is that supersampling of color channels is quite a bit slower than aux channels. You may find that 1 x 3 LowQ/HiQ Rate is sufficient for color, but for world position or Z, you may require 4 x 12 to get adequate results. The reasons color anti-aliasing is slower are that the shaders for RGBA can be 10x to even 100x or 1000x more complex, and color is rendered with sorting enabled, while aux channels get rendered using the much faster Z-buffer method.

**TIP:** For some things, sometimes using an SS Z-buffer improves quality, but for other things like using the merge’s PerformDepthMerge option, it may make things worse.
Do not mistake anti-aliasing with improved quality. Anti-aliasing an aux channel does not mean it’s better quality. In fact, anti-aliasing an aux channel in many cases can make the results much worse. The only aux channels we recommend you enable anti-aliasing on are WorldCoord and Z.

**TIP:** We strongly recommend disabling Anti-Aliasing on Material ID and Object ID channels, TexCoord, Normal, BackVector, and Vector channels. The issue arises when you have multiple 3D surfaces with radically different TexCoord values in one pixel. The anti-aliasing does not restrict itself to sampling the main surface but samples both surfaces. For example, if one surface has TexCoords that are approximately \((u,v) = (0, 0)\) within that pixel, and the other surface has \((0.5, 0.5)\), you get a blending of these two. The blended area of the texture could have colors like \((0, 0)\) or \((0.5, 0.5)\), resulting in an oddly colored pixel artifact being output from the 2D Texture node. The same problem can happen for normals.

**Enable (LowQ/HiQ)**

These two check boxes are used to enable anti-aliasing of the rendered image.

**Supersampling LowQ/HiQ Rate**

The LowQ and HiQ rate tells the OpenGL render how large to scale the image. For example, if the rate is set to 4 and the OpenGL renderer is set to output a 1920 x 1080 image, internally a 7680 x 4320 image is rendered and then scaled back to produce the target image. Set the multiplier higher to get better edge anti-aliasing at the expense of render time. Typically 8 x 8 supersampling (64 samples per pixel) is sufficient to reduce most aliasing artifacts.

The rate doesn’t exactly define the number of samples done per destination pixel; the width of the reconstruction filter used may also have an impact.

**Filter Type**

When downsampling the supersized image, the surrounding pixels around a given pixel are often used to give a more realistic result. There are various filters available for combining these pixels. More complex filters can give better results but are usually slower to calculate. The best filter for the job often depends on the amount of scaling and on the contents of the image itself.

The functions of these filters are shown in the image above. From left to right these are:

<table>
<thead>
<tr>
<th>Filter Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Box</td>
<td>This is a simple interpolation scale of the image.</td>
</tr>
<tr>
<td>Bi-Linear (triangle)</td>
<td>This uses a simplistic filter, which produces relatively clean and fast results.</td>
</tr>
<tr>
<td>Bi-Cubic (quadratic)</td>
<td>This filter produces a nominal result. It offers a good compromise between speed and quality.</td>
</tr>
<tr>
<td>Bi-Spline (cubic)</td>
<td>This produces better results with continuous tone images but is slower than Quadratic. If the images have fine detail in them, the results may be blurrier than desired.</td>
</tr>
<tr>
<td>Catmul-Rom</td>
<td>This produces good results with continuous tone images which are scaled down, producing sharp results with finely detailed images.</td>
</tr>
<tr>
<td>Gaussian</td>
<td>This is very similar in speed and quality to Quadratic.</td>
</tr>
<tr>
<td>Mitchell</td>
<td>This is similar to Catmul-Rom but produces better results with finely detailed images. It is slower than Catmul-Rom.</td>
</tr>
</tbody>
</table>
Lanczos: This is very similar to Mitchell and Catmull-Rom but is a little cleaner and also slower.

Sinc: This is an advanced filter that produces very sharp, detailed results, however, it may produce visible ‘ringing’ in some situations.

Bessel: This is similar to the Sinc filter but may be slightly faster.

**Window Method**
The Window Method menu appears only when the reconstruction filter is set to Sinc or Bessel.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hanning</td>
<td>This is a simple tapered window.</td>
</tr>
<tr>
<td>Hamming</td>
<td>Hamming is a slightly tweaked version of Hanning.</td>
</tr>
<tr>
<td>Blackman</td>
<td>A window with a more sharply tapered falloff.</td>
</tr>
</tbody>
</table>

**Accumulation Effects**
Accumulation effects are used for creating depth of field effects. Enable both the Enable Accumulation Effects and Depth of Field checkboxes, and then adjust the quality and Amount sliders.

The blurrier you want the out-of-focus areas to be, the higher the quality setting you need. A low amount setting causes more of the scene to be in focus.

The accumulation effects work in conjunction with the Focal plane setting located in the Camera 3D node. Set the Focal Plane to the same distance from the camera as the subject you want to be in focus. Animating the Focal Plane setting creates rack of focus effects.

**Lighting**
- **Enable Lighting:** When the Enable Lighting checkbox is selected, any lights in the scene light objects. If no lights are present, all objects are black.
- **Enable Shadows:** When the Enable Shadows checkbox is selected, the renderer produces shadows, at the cost of some speed.

**Texturing**
- **Texture Depth:** Lets you specify the bit depth of texture maps.
- **Warn about unsupported texture depths:** Enables a warning if texture maps are in an unsupported bit depth that Fusion can’t process.

**Lighting Mode**
The Per-vertex lighting model calculates lighting at each vertex of the scene’s geometry. This produces a fast approximation of the scene’s lighting but tends to produce blocky lighting on poorly tessellated objects. The Per-pixel method uses a different approach that does not rely on the detail in the scene’s geometry for lighting, so it generally produces superior results.

Although the per-pixel lighting with the OpenGL renderer produces results closer to that produced by the more accurate software renderer, it still has some disadvantages. The OpenGL renderer is less capable of dealing correctly with semi-transparency, soft shadows, and colored shadows, even with per-pixel lighting. The color depth of the rendering is limited by the capabilities of the graphics card in the system.
Transparency

The OpenGL renderer reveals this control for selecting which ordering method to use when calculating transparency.

– **Z Buffer (fast):** This mode is extremely fast and is adequate for scenes containing only opaque objects. The speed of this mode comes at the cost of accurate sorting; only the objects closest to the camera are certain to be in the correct sort order. So, semi-transparent objects may not be shown correctly, depending on their ordering within the scene.

– **Sorted (accurate):** This mode sorts all objects in the scene (at the expense of speed) before rendering, giving correct transparency.

– **Quick Mode:** This experimental mode is best suited to scenes that almost exclusively contain particles.

Shading Model

Use this menu to select a shading model to use for materials in the scene. Smooth is the shading model employed in the viewers, and Flat produces a simpler and faster shading model.

Wireframe

Renders the whole scene as wireframe. This shows the edges and polygons of the objects. The edges are still shaded by the material of the objects.

Wireframe Anti-Aliasing

Enables anti-aliasing for the Wireframe render.

OpenGL UV Renderer

The OpenGL UV renderer is a special case render engine. It is used to take a model with existing textures and render it out to produce an unwound flattened 2D version of the model. Optionally, lighting can be baked in. This is typically done so you can then paint on the texture and reapply it.
Below are some issues to be aware of when using the OpenGL UV renderer.

**Baked-in lighting:** After you have baked lighting into a model’s texture, you need to be careful to turn lighting off on the object later when you render it with the baked-in lighting texture.

**Single textures/multiple destinations:** Beware of cases where a single area of the texture map is used on multiple areas of the model. This is often done to save texture memory and decrease modeling time. An example is the texture for a person where the artist mirrored the left side mesh/uvs/texture to produce the right side. Trying to bake in lighting in this case won’t work.

**Unwrapped more the one mesh:** Unwrapping more than one mesh at once can cause problems. The reason is that most models are authored so they make maximum usage of (u,v) in \([0,1] \times [0,1]\), so that in general models overlap each other in UV space.

**Seams:** When the UV gutter size is left at 0, this produces seams when the model is retextured with the unwrapped texture.

**UV Gutter Size:** Increase this value to hide seams between faces.

---

**Common Controls**

**Image and Settings Tabs**

The remaining controls for the Image and Settings tabs are common to many 3D nodes. Their descriptions can be found in “The Common Controls” section at the end of this chapter.

---

### Replace Material 3D [3RPL]

The Replace Material 3D node replaces the material applied to all the geometry in the input scene with its own material input. Any lights or cameras in the input scene are passed through unaffected.

The scope of the replacement can be limited using Object and Material identifiers in the Inspector. The scope can also be limited to individual channels, making it possible to use a completely different material on the Red channel, for example.

Since the Text 3D node does not include a material input, you can use the Replace Material to add material shaders to the text.

### Inputs

The Replace Material node has two inputs: one for the 3D scene, object, or 3D text that contains the original material, and a material input for the new replacement material.

- **ScenInput:** The orange scene input accepts a 3D scene or 3D text that you want to replace the material.

- **MaterialInput:** The green material input accepts either a 2D image or a 3D material. If a 2D image is provided, it is used as a diffuse texture map for the basic material built into the node. If a 3D material is connected, then the basic material is disabled.
Basic Node Setup

The Replace Material 3D node is inserted directly after the 3D object or scene whose material you want to replace. Below, it is used to replace the default material on a Text 3D node with a chrome shader.

![Replace Material 3D used to replace the default material of a Text 3D node](image)

Inspector

Controls Tab

**Enable**

This checkbox enables the material replacement. This is not the same as the red switch in the upper-left corner of the Inspector. The red switch disables the tool altogether and passes the image on without any modification. The enable checkbox is limited to the effect part of the tool. Other parts, like scripts in the Settings tab, still process as normal.

**Replace Mode**

The Replace Mode section offers four methods of replacing each RGBA channel:

- **Keep**: Prevents the channel from being replaced by the input material.
- **Replace**: Replaces the material for the corresponding color channel.
- **Blend**: Blends the materials together.
- **Multiply**: Multiplies the channels of both inputs.

**Limit by Object ID/Material ID**

When enabled, a slider appears where the desired IDs can be set. Other objects keep their materials. If both options are enabled, an object must satisfy both conditions.
Common Controls

Material and Settings Tabs
The remaining controls for the Material and Settings tabs are common to many 3D nodes. Their descriptions can be found in "The Common Controls" section at the end of this chapter.

Replace Normals 3D [3RPN]

Replace Normals Node Introduction
In 3D modeling, normals are vectors used to determine the direction light reflects off surfaces. The Replace Normals node is used to replace the normals/tangents on incoming geometry, effectively adjusting the surface of an object between smooth and flat. All geometry connected to the scene input on the node is affected. Lights/Cameras/PointClouds/Locators/Materials, and other non-mesh nodes are passed through unaffected. The normals/tangents affected by this node are Per-vertex normals/tangents, not Per-face normals/tangents. The input geometry must have texture coordinates in order for tangents to be computed. Sometimes geometry does not have texture coordinates, or the texture coordinates were set to All by the FBX import because they were not present on the FBX.

Inputs
The Replace Normals node has a single input for the 3D scene or incoming geometry.

- **SceneInput**: The orange scene input accepts a 3D scene or 3D geometry that contains the normal coordinates you want to modify.

Basic Node Setup
The Replace Normals 3D node is inserted directly after the 3D object or scene whose normals you want to modify. Below, it is used to smooth the material on an imported 3D model.
Inspector

The options in the Control tab deal with repairing 3D geometry and then recomputing normals/tangents.

Pre-Weld Position Vertices
Sometimes position vertices are duplicated in a geometry, even though they have the same position, causing normals/tangents to be miscomputed. The results of pre-welding are thrown away; they do not affect the output geometry’s position vertices.

Recompute
Controls when normals/tangents are recomputed.
- **Always**: The normals on the mesh are always recomputed.
- **If Not Present**: The normals on the mesh are recomputed only if they are not present.
- **Never**: The normals are never computed. This option is useful when animating.

Smoothing Angle
Adjacent faces with angles in degrees smaller than this value have their adjoining edges smoothed across. A typical value one might choose for the Smoothing Angle is between 20 and 60 degrees. There is special case code for 0.0f and 360.0f (f stands for floating-point value). When set to 0.0f, faceted normals are produced; this is useful for artistic effect.

Ignore Smooth Groups
If set to False, two faces that have different Smooth Groups are not smoothed across (e.g., the faces of a cube or the top surfaces of a cylinder have different Smooth Groups). If you check this On and set the smoothing angle large enough, the faces of a cube are smoothed across. There is currently no way to visualize Smooth Groups within Fusion.

Flip Normals
Flipping of tangents can sometimes be confusing. Flip has an effect if the mesh has tangent vectors. Most meshes in Fusion don’t have tangent vectors until they reach a Renderer 3D, though. Also, when viewing tangent vectors in the viewers, the tangent vectors are created if they don’t exist. The confusing thing is if you view a Cube 3D that has no tangent vectors and press the FlipU/FlipV button, nothing happens. This is a result of there being no tangent vectors to create, but later the GL renderer can create some (unflipped) tangent vectors.
There are five items you should be aware of when dealing with normals.

#1 The FBX importer recomputes the normals if they don’t exist, but you can get a higher-quality result from the Replace Normals node.

#2 Bump maps can sometimes depend on the model’s normals. Specifically, when you simplify a complex high polygon model to a low polygon model + bump map, the normals and bump map can become “linked.” Recomputing the normals in this case can make the model look funny. The bump map was intended to be used with the original normals.

#3 Most primitives in Fusion are not generated with tangents; when needed, they are generated on the fly by a Renderer 3D and cached.

#4 Tangents currently are only needed for bump mapping. If a material needs bump mapping, then tangents are created. These tangents are created with some default settings (e.g., Smoothing Angle, and so on). If you don’t want Fusion automatically creating tangents, you can use the Replace Normals node to create them manually.

#5 All computations are done in the local coordinates of the geometries instead of in the coordinate system of the Replace Normals 3D node. This can cause problems when there is a non-uniform scale applied to the geometry before Replace Normals 3D is applied.

Common Controls

Settings Tab
The Settings tab is common to many 3D nodes. The description of these controls can be found in “The Common Controls” section at the end of this chapter.

Replicate 3D [3REP]

Replicate 3D Node Introduction
The Replicate 3D node replicates input geometry at positions of destination vertices. The vertices can be mesh vertices as well as particle positions. For each copy of the replicated input geometry, various transformations can be applied. The options in the Jitter tab allow non-uniform transformations, such as random positioning or sizes.

Inputs
There are two inputs on the Replicate 3D node: one for the destination geometry that contains the vertices, and one for the 3D geometry you want to replicate.

– **Destination**: The orange destination input accepts a 3D scene or geometry with vertex positions, either from the mesh or 3D particle animations.

– **Input[#]**: The input accepts the 3D scene or geometry for replicating. Once this input is connected, a new input for alternating 3D geometry is created.

At least one connected input is required.
Basic Node Setup

In the example below, a Replicate 3D node is inserted directly after the pRender node. A spaceship FBX node is connected to the green input representing the object that will be replicated based on the particles. Each particle cell takes on the shape of the 3D geometry connected to the input.

Replicate 3D used to create an armada of swarming spaceships

Inspector

Replicated 3D Jitter controls

Controls Tab

Step

Defines how many positions are skipped. For example, a step of 3 means that only every third vertex of the destination mesh is used, while a step of 1 means that all positions are used.

The Step setting helps to keep reasonable performance for big destination meshes. On parametric geometry like a torus, it can be used to isolate certain parts of the mesh.
Point clouds are internally represented by six points once the Make Renderable option has been set. To get a single point, use a step of 6 and set an X offset of −0.5 to get to the center of the point cloud. Use −0.125 for Locator 3Ds. Once these have been scaled, the offset may differ.

**Input Mode**

This menu defines in which order multiple input scenes are replicated at the destination. No matter which setting you choose, if only one input scene is supplied this setting has no effect.

- When set to Loop, the inputs are used successively. The first input is at the first position, the second input at the second position, and so on. If there are more positions in the destination present than inputs, the sequence is looped.
- When set to Random, a definite but random input for each position is used based on the seed in the Jitter tab. This input mode can be used to simulate variety with few input scenes.
- The Death of Particles setting causes the input geometries’ IDs to change; therefore, their copy order may change.

![The Input Mode Loop vs. Random order](image)

**Time Offset**

Use the Time Offset slider to offset any animations that are applied to the input geometry by a set amount per copy. For example, set the value to −1.0 and use a cube set to rotate on the Y-axis as the source. The first copy shows the animation from a frame earlier; the second copy shows animation from a frame before that, etc.

This can be used with great effect on textured planes—for example, where successive frames of a video clip can be shown.

**Alignment**

Alignment specifies how to align the copies in respect of the destination mesh normal or particle rotation.

- **Not Aligned**: Does not align the copy. It stays rotated in the same direction as its input mesh.

![Replicate 3D Not Aligned layout](image)
– **Aligned**: This mode uses the point’s normal and tries to reconstruct an upvector. It works best with organic meshes that have unwelded vertices, like imported FBX meshes, since it has the same rotations for vertices at the same positions. On plane geometric meshes, a gradual shift in rotation is noticeable. For best results, it is recommended to use this method at the origin before any transformations.

![Replicate 3D Aligned layout](image)

– **Aligned TBN**: This mode results in a more accurate and stable alignment based on the tangent, binormal, and normal of the destination point. This works best for particles and geometric shapes. On unwelded meshes, two copies of multiple unwelded points at the same position may lead to different alignments because of their individual normals.

![Replicate 3D Aligned TBN layout](image)

**Color**

Affects the diffuse color or shader of each copy based on the input’s particle color.

– **Use Object Color**: Does not use the color of the destination particle.

– **Combine Particle Color**: Uses the shader of any input mesh and modifies the diffuse color to match the color from the destination particle.

– **Use Particle Color**: Replaces the complete shader of any input mesh with a default shader. Its diffuse color is taken from the destination particle.
Replicate 3D Color options

Translation
These three sliders tell the node how much offset to apply to each copy. An X Offset of 1 would offset each copy one unit, one unit along the X-axis from the last copy.

Rotation Order
These buttons can be used to set the order in which rotations are applied to the geometry. Setting the rotation order to XYZ would apply the rotation on the X-axis first, followed by the Y-axis rotation, and then the Z-axis rotation.

XYZ Rotation
These three rotation sliders tell the node how much rotation to apply to each copy.

XYZ Pivot
The pivot controls determine the position of the pivot point used when rotating each copy.

Lock XYZ
When the Lock XYZ checkbox is selected, any adjustment to the scale is applied to all three axes simultaneously.
If this checkbox is disabled, the Scale slider is replaced with individual sliders for the X, Y, and Z scales.

Scale
The Scale control sets how much scaling to apply to each copy.
Jitter Tab
The Jitter tab can be used to introduce randomness to various parameters.

Random Seed/Randomize
The Random Seed is used to generate the jitter applied to the replicated objects. Two Replicate nodes with identical settings but different random seeds will produce two completely different results. Click the Randomize button to assign a Random Seed value.

Time Offset
Use the Time Offset slider to offset any animations that are applied to the source geometry. Unlike Time Offset on the Controls tab, Jitter Time Offset is random, based on the Random Seed setting.

Translation XYZ Jitter
Use these three controls to adjust the variation in the translation of the replicated objects.

Rotation XYZ Jitter
Use these three controls to adjust the variation in the rotation of the replicated objects.

Pivot XYZ Jitter
Use these three controls to adjust the variation in the rotational pivot center of the replicated objects. This affects only the additional jitter rotation, not the rotation produced by the rotation settings in the Controls tab.

Scale XYZ Jitter
Use this control to adjust the variation in the scale of the replicated objects. Uncheck the Lock XYZ checkbox to adjust the scale variation independently on all three axes.
Common Controls

Settings Tab
The Settings tab is common to many 3D nodes. The description of these controls can be found in “The Common Controls” section at the end of this chapter.

Ribbon 3D [3RI]

Ribbon 3D Node Introduction
Ribbon 3D generates an array of subdivided line segments or a single line between two points. It is quite useful for motion graphics, especially in connection with Replicate 3D to attach other geometry to the lines, and with Displace3D for creating lightning bolt-like structures. The array of lines is, by default, assigned with texture coordinates, so they can be used with a 2D texture. As usual, UVMap 3D can be used to alter the texture coordinates. This node relies heavily on certain OpenGL features and does not produce any visible result when the Renderer 3D node is set to use the software renderer.

Furthermore, the way lines are drawn is completely up to the graphics card capabilities, so the ribbon appearance may vary based on your computer’s graphics card.

Inputs
There are two inputs on the Ribbon 3D node: one for the destination geometry that contains the vertices, and one for the 3D geometry you want to replicate.

- **3D Scene**: The orange input accepts a 3D scene or geometry.
- **Material**: The input accepts the 2D texture for the ribbon.

Neither connected input is required.

Basic Node Setup
In the example below, a Ribbon 3D node is used to generate lines. A gradient background is connected to “colorize” the lines. Additional nodes are then used after the Ribbon 3D to bend and distort the lines.
Inspector

Ribbon 3D controls

Controls Tab
The Controls tab determines the number of ribbon strands, their size, length, and spacing.

Number of Lines
The number of parallel lines drawn between the start point and end point.

Line Thickness
Line thickness is allowed in the user interface to take on a floating-point value, but some graphics cards allow only integer values. Some cards may only allow lines equal to or thicker than one, or max out at a certain value.

Subdivision Level
The number of vertices on each line between start point and end points. The higher the number, the more precise and smoother 3D displacement appears.

Ribbon Width
Determines how far the lines are apart from each other.

Start
XYZ control to set the start point of the ribbon.

End
XYZ control to set the end point of the ribbon.

Ribbon Rotation
Allows rotation of the ribbon around the virtual axis defined by start point and end points.

Anti-Aliasing
Allows you to apply anti-aliasing to the rendered lines. Using anti-aliasing isn’t necessarily recommended. When activated, there may be gaps between the line segments. This is especially noticeable with high values of line thickness. Again, the way lines are drawn is completely up to the graphics card, which means that these artifacts can vary from card to card.
Common Controls

Controls, Materials, and Settings Tabs
The controls for Visibility, Lighting, Matte, Blend Mode, Normals/Tangents, and Object ID in the Controls tab are common in many 3D nodes. The Materials tab and Settings tab in the Inspector are also duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Shape 3D [3SH]

The Shape 3D node

Shape 3D Node Introduction
The Shape 3D node is used to produce several basic primitive 3D shapes, including planes, cubes, spheres, and cylinders.

Inputs
There are two optional inputs on the Shape 3D. The scene input can be used to combine additional geometry with the Shape 3D, while the material input can be used to texture map the Shape 3D object.

– **SceneInput:** Although the Shape 3D creates its own 3D geometry, you can use the orange scene input to combine an additional 3D scene or geometry.

– **MaterialInput:** The green input accepts either a 2D image or a 3D material. If a 2D image is provided, it is used as a diffuse texture map for the basic material built into the node. If a 3D material is connected, then the basic material is disabled.

Basic Node Setup
In the example below, four Shape 3D nodes are used to create the primitives of a 3D set. Two of the Shape 3D nodes are connected creating a more complex primitive shape. Those shapes can then be used with a Projector 3D to texture them with a realistic material.

Shape 3D nodes combined with Projector 3D to create a realistic 3D set
Inspector

Controls Tab
The Controls tab allows you to select a shape and modify its geometry. Different controls appear based on the specific shape that you choose to create.

**Shape**
This menu allows you to select the primitive geometry produced by the Shape 3D node. The remaining controls in the Inspector change to match the selected shape.

- **Lock Width/Height/Depth:** [plane, cube] If this checkbox is selected, the width, height, and depth controls are locked together as a single size slider. Otherwise, individual controls over the size of the shape along each axis are provided.
- **Size Width/Height/Depth:** [plane, cube] Used to control the size of the shape.

**Cube Mapping**
When Cube is selected in the shape menu, the Cube uses cube mapping to apply the Shape node’s texture (a 2D image connected to the material input on the node).

**Radius**
When a Sphere, Cylinder, Cone, or Torus is selected in the shape menu, this control sets the radius of the selected shape.

**Top Radius**
When a cone is selected in the Shape menu, this control is used to define a radius for the top of a cone, making it possible to create truncated cones.

**Start/End Angle**
When the Sphere, Cylinder, Cone, or Torus shape is selected in the Shape menu, this range control determines how much of the shape is drawn. A start angle of 180° and end angle of 360° would only draw half of the shape.

**Start/End Latitude**
When a Sphere or Torus is selected in the Shape menu, this range control is used to crop or slice the object by defining a latitudinal subsection of the object.
Bottom/Top Cap
When Cylinder or Cone is selected in the Shape menu, the Bottom Cap and Top Cap checkboxes are used to determine if the end caps of these shapes are created or if the shape is left open.

Section
When the Torus is selected in the Shape menu, Section controls the thickness of the tube making up the torus.

Subdivision Level/Base/Height
The Subdivision controls are used to determine the tessellation of the mesh on all shapes. The higher the subdivision, the more vertices each shape has.

Wireframe
Enabling this checkbox causes the mesh to render only the wireframe for the object.

Common Controls

Controls, Materials, Transform and Settings Tabs
The controls for Visibility, Lighting, Matte, Blend Mode, Normals/Tangents, and Object ID in the Controls tab are common in many 3D nodes. The Materials tab, Transforms tab, and Settings tab in the Inspector are also duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Sphere Map vs. Connecting the Texture to a Sphere Directly
You can connect a LatLong (equirectangular) texture map directly to a sphere instead of piping it through the Sphere Map node first. This results in a different rendering if you set the start/end angle and latitude to less than 360°/180°. In the first case, the texture is squashed. When using the Sphere Map node, the texture is cropped. Compare:

![Spherical mapping differences](image)

**NOTE:** If you pipe the texture directly into the sphere, it is also mirrored horizontally. You can change this by using a Transform node first.
Soft Clip Node Introduction

The Soft Clip node is used to fade out geometry and particles that get close to the camera. This helps avoid the visible “popping off” that affects many particle systems and 3D flythroughs.

This node is very similar to the Fog 3D node, in that it is dependent on the geometry’s distance from the camera.

Inputs

The Soft Clip includes only a single input for a 3D scene that includes a camera connected to it.

– SceneInput: The orange scene input is a required connection. It accepts a 3D scene input that includes a Camera 3D node.

Basic Node Setup

The Soft Clip node is usually placed just before the Renderer 3D node to ensure that downstream adjustments to lighting and textures do not affect the result. It can be placed in any part of the 3D portion of the node tree if the soft clipping effect is only required for a portion of the scene.
Inspector

Controls Tab
The Controls tab determines how an object transitions between opaque and transparent as it moves closer to the camera.

Enable
This checkbox can be used to enable or disable the node. This is not the same as the red switch in the upper-left corner of the Inspector. The red switch disables the tool altogether and passes the image on without any modification. The Enable checkbox is limited to the effect of the tool. Other parts, like scripts in the Settings tab, still process as normal.

Smooth Transition
By default, an object coming closer and closer to the camera slowly fades out with a linear progression. With the Smooth Transition checkbox enabled, the transition changes to a nonlinear curve, arguably a more natural-looking transition.

Radial
By default, the soft clipping is done based on the perpendicular distance to a plane (parallel with the near plane) passing through the eye point. When the Radial option is checked, the Radial distance to the eye point is used instead of the Perpendicular distance. The problem with Perpendicular distance soft clipping is that when you move the camera about, as objects on the left or right side of the frustum move into the center, they become less clipped, although they remain the same distance from the eye. Radial soft clip fixes this. Sometimes Radial soft clipping is not desirable.

For example, if you apply soft clip to an object that is close to the camera, like an image plane, the center of the image plane could be unclipped while the edges could be fully clipped because they are farther from the eye point.

Show In Display Views
Normally, the effect is only visible when the scene is viewed using a Camera node. When enabled, the soft clip becomes visible in the scene from all points of view.

Transparent/Opaque Distance
Defines the range of the soft clip. The objects begin to fade in from an opacity of 0 at the Transparent distance and are fully visible at the Opaque distance. All units are expressed as distance from the camera along the Z-axis.

Common Controls

Settings Tab
The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
Spherical Camera Node Introduction

The Spherical Camera allows the 3D Renderer node to output an image covering all viewing angles, laid out in several different formats. This image may be used, for example, as a skybox texture or reflection map or viewed in a VR headset. The Image Width setting in the 3D Renderer sets the size of each square cube face, so the resulting image may be a multiple of this size horizontally and vertically.

Inputs

The Spherical camera node has two inputs.

- **Image**: This orange image input requires an image in a spherical layout, which can be any of LatLong (2:1 equirectangular), Horizontal/Vertical Cross, or Horizontal/Vertical Strip.

- **Stereoscopic Input**: The green input for a right stereo camera if you are working in stereo VR.

Neither input is required.

Basic Node Setup

In many ways, the Spherical Camera is set up identically to the regular Camera 3D node. The output of the camera connects into a Merge 3D. Typically, the Merge 3D has an image from a LatLong or H Cross/V Cross formatted image either directly or through a Panomap node. The image is wrapped around a sphere, and the camera is placed inside the sphere.
Inspector

Controls Tab

Layout
- **VCross and HCross**: VCross and HCross are the six square faces of a cube laid out in a cross, vertical or horizontal, with the forward view in the center of the cross, in a 3:4 or 4:3 image.
- **VStrip and HStrip**: VStrip and HStrip are the six square faces of a cube laid vertically or horizontally in a line, ordered as Left, Right, Up, Down, Back, Front (+X, -X, +Y, -Y, +Z, -Z), in a 1:6 or 6:1 image.
- **LatLong**: LatLong is a single 2:1 image in equirectangular mapping.

Near/Far Clip
The clipping plane is used to limit what geometry in a scene is rendered based on the object’s distance from the camera’s focal point. This is useful for ensuring that objects that are extremely close to the camera are not rendered and for optimizing a render to exclude objects that are too far away to be useful in the final rendering.

The default perspective camera ignores this setting unless the Adaptively Adjust Near/Far Clip checkbox control below is disabled.

The values are expressed in units, so a far clipping plane of 20 means that any objects more than 20 units from the camera are invisible to the camera. A near clipping plane of 0.1 means that any objects closer than 0.1 units are also invisible.

Adaptively Adjust Near/Far Clip
When selected, the Renderer automatically adjusts the camera’s near/far clipping plane to match the extents of the scene. This setting overrides the values of the Near and Far clip range control described above. This option is not available for orthographic cameras.
Viewing Volume Size
The Viewing Volume Size control appears only when the Projection Type is set to Orthographic. It determines the size of the box that makes up the camera’s field of view. The Z distance of an orthographic camera from the objects it sees does not affect the scale of those objects, only the viewing size does.

**NOTE:** A smaller range between the near and far clipping plane allows greater accuracy in all depth calculations. If a scene begins to render strange artifacts on distant objects, try increasing the distance for the near clip plane. Use the vertical aperture size to get the vertical angle of view and the horizontal aperture size to get the horizontal angle of view.

Plane of Focus (for Depth of Field)
This value is used by the OpenGL renderer to calculate depth of field. It defines the distance to a virtual target in front of the camera.

Stereo Method
This control allows you to adjust your stereoscopic method to your preferred working model.

Toe In
Both cameras point at a single focal point. Though the result is stereoscopic, the vertical parallax introduced by this method can cause discomfort by the audience.

Off Axis
Often regarded as the correct way to create stereo pairs, this is the default method in Fusion. Off Axis introduces no vertical parallax, thus creating less stressful stereo images.

Parallel
The cameras are shifted parallel to each other. Since this is a purely parallel shift, there is no Convergence Distance control. Parallel introduces no vertical parallax, thus creating less stressful stereo images.

Eye Separation
Defines the distance between both stereo cameras. If the Eye Separation is set to a value larger than 0, controls for each camera are shown in the viewer when this node is selected. There is no Convergence Distance control in Parallel mode.

Convergence Distance
This control sets the stereoscopic convergence distance, defined as a point located along the Z-axis of the camera that determines where both left and right eye cameras converge.

Control Visibility
Allows you to selectively activate the onscreen controls that are displayed along with the camera.

- **Frustum:** Displays the actual viewing cone of the camera.
- **View Vector:** Displays a white line inside the viewing cone, which can be used to determine the shift when in Parallel mode.
- **Near Clip:** The Near clipping plane. This plane can be subdivided for better visibility.
- **Far Clip:** The Far clipping plane. This plane can be subdivided for better visibility.
- **Plane of Focus:** The camera focal point according to the Plane of Focus slider explained above. This plane can be subdivided for better visibility.
- **Convergence Distance:** The point of convergence when using Stereo mode. This plane can be subdivided for better visibility.
Common Controls

Settings Tab
The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Text 3D [3TXT]

Text 3D Node Introduction
The Text3D node is a 3D version of the 2D Text+ node. The controls for this node are mostly identical to the controls for the 2D version in almost all respects, except Text 3D supports only one shading element.

The Text 3D node was based on a tool that predates the Fusion 3D environment. So, some of the controls found in the basic primitive shapes and geometry loaders, such as many of the material, lighting, and matte options, are not found in this node’s controls. The Text 3D node has a built-in material, but unlike the other 3D nodes it does not have a material input. The Shading tab contains controls to adjust the diffuse and specular components. To replace this default material with a more advanced material, follow the Text Plus node with a Replace Material 3D node. The Override 3D node can be used to control the lighting, visibility, and matte options for this node.

When network rendering a comp that contains Text 3D nodes, each render machine is required to have the necessary fonts installed or the network rendering fails. Fusion does not share or copy fonts to render slaves.

Inputs

– SceneInput: The orange scene input accepts a 3D scene that can be combined with the 3D text created in the node.

– ColorImage: The green color image input accepts a 2D image and wraps it around the text as a texture. This input is visible only when Image is selected in the Material Type menu located in the Shading tab.

– BevelTexture: The magenta bevel texture input accepts a 2D image and wraps it around the bevel as a texture. This input is visible only when one Material is disabled in the Shader tab and Image is selected in the Bevel Type menu.

Basic Node Setup
The Text 3D node generates text, so most often this node starts a branch of your node tree. However, to apply more realistic materials, a replace Material node is often added after the Text 3D, prior to connecting into a Merge 3D node.
Inspector

Text 3D controls

Text Tab
The Text 3D text tab in the Inspector is divided into three sections: Text, Extrusion, and Advanced Controls. The Text section includes parameters that are familiar to anyone who has used a word processor. It includes commonly used text formatting options. The Extrusion section includes controls to extrude the text and create beveled edges for the text. The Advanced controls are used for kerning options.

Styled Text
The Edit box in this tab is where the text to be created is entered. Any common character can be typed into this box. The common OS clipboard shortcuts (Command-C or Ctrl-C to copy, Command-X or Ctrl-X to cut, Command-V or Ctrl-V to paste) also work; however, right-clicking on the Edit box displays a custom contextual menu with several modifiers you can add for more animation and formatting options.
Font
Two Font menus are used to select the font family and typeface such as Regular, Bold, and Italic.

Color
This control sets the basic tint color of the text. This is the same Color control displayed in the Material type section of the Shader tab.

Size
This control is used to increase or decrease the size of the text. This is not like selecting a point size in a word processor. The size is relative to the width of the image.

Tracking
The Tracking parameter adjusts the uniform spacing between each character of text.

Line Spacing
Line Spacing adjusts the distance between each line of text. This is sometimes called leading in word-processing applications.

V Anchor
The Vertical Anchor controls consist of three buttons and a slider. The three buttons are used to align the text vertically to the top, middle, or bottom baseline of the text. The slider can be used to customize the alignment. Setting the Vertical Anchor affects how the text is rotated but also the location for line spacing adjustments. This control is most often used when the Layout type is set to Frame in the Layout tab.

V Justify
The Vertical Justify slider allows you to customize the vertical alignment of the text from the V Anchor setting to full justification so it is aligned evenly along the top and bottom edges. This control is most often used when the Layout type is set to Frame in the Layout tab.

H Anchor
The Horizontal Anchor controls consist of three buttons and a slider. The three buttons justify the text alignment to the left edge, middle, or right edge of the text. The slider can be used to customize the justification. Setting the Horizontal Anchor affects how the text is rotated but also the location for tracking (leading) spacing adjustments. This control is most often used when the Layout type is set to Frame in the Layout tab.

H Justify
The Horizontal Justify slider allows you to customize the justification of the text from the H Anchor setting to full justification so it is aligned evenly along the left and right edges. This control is most often used when the Layout type is set to Frame in the Layout tab.

Direction
This menu provides options for determining the direction in which the text is to be written.

Line Direction
These menu options are used to determine the text flow from top to bottom, bottom to top, left to right, or right to left.

Write On
This range control is used to quickly apply simple Write On and Write Off animation to the text. To create a Write On effect, animate the End portion of the control from 1 to 0 over the length of time required. To create a Write Off effect, animate the Start portion of the range control from 0 to 1.
**Extrusion Depth**

An extrusion of 0 produces completely 2D text. Any value greater than 0 extrudes the text to generate text with depth.

![Text 3D extrusion and bevel controls](image)

**Bevel Depth**

Increase the value of the Bevel Depth slider to bevel the text. The text must have extrusion before this control has any effect.

**Bevel Width**

Use the Bevel Width control to increase the width of the bevel.

**Smoothing Angle**

Use this control to adjust the smoothing angle applied to the edges of the bevel.

**Front/Back Bevel**

Use these checkboxes to enable beveling for the front and back faces of the text separately.

**Custom Extrusion**

In Custom mode, the Smoothing Angle controls the smoothing of normals around the edges of a text character. The spline itself controls the smoothing along the extrusion profile. If a spline segment is smoothed, for example by using the shortcut Shift-S, the normals are smoothed as well. If the control point is linear, the shading edge is sharp. The first and last control points on the spline define the extent of the text.

**Custom Extrusion Subdivisions**

Controls the number of subdivisions within the smoothed portions of the extrusion profile.

**TIP:**

Splines can also be edited from within the Spline Editor panel. It provides a larger working space for working with any spline including the Custom Extrusion.

**Extrusion profile spline control:**

Do not try to go to zero size at the Front/Back face. This results in Z-fighting resulting from self-intersecting faces. To avoid this problem, make sure the first and last point have their profiles set to 0.

**Force Monospaced**

This slider control can be used to override the kerning (spacing between characters) that is defined in the font. Setting this slider to zero (the default value) causes Fusion to rely entirely on the kerning defined with each character. A value of one causes the spacing between characters to be completely even, or monospaced.
Text 3D Advanced Controls can be used to manually kern letters.

**Use Font Defined Kerning**
This enables kerning as specified in the True Type font and is on by default.

**Manual Font Kerning**
Manual Font Kerning is only performed using the Text+ node. To perform manual kerning on Text3D, create the text using the Text+ node and kern it in that tool. Then, right-click over the tool’s name in the Inspector and choose Copy. Once the settings are copied, select the Text 3D node and choose Paste Settings from the Inspector’s contextual menu. Once the manual kerning is pasted in the Text 3D node, the two buttons in the Inspector clear either the selected character’s kerning or all the kerning adjustment in the current text.

**Layout Tab**
The Layout Tab is used to position the text in one of four different layout types.

**Layout Type**
This menu selects the layout type for the text.

- **Point**: Point layout is the simplest of the layout modes. Text is arranged around an adjustable center point.

- **Frame**: Frame layout allows you to define a rectangular frame used to align the text. The alignment controls are used to justify the text vertically and horizontally within the boundaries of the frame.

- **Circle**: Circle layout places the text around the curve of a circle or oval. Control is offered over the diameter and width of the circular shape. When the layout is set to this mode, the Alignment controls determine whether the text is positioned along the inside or outside of the circle’s edge, and how multiple lines of text are justified.

- **Path**: Path layout allows you to shape your text along the edges of a path. The path can be used simply to add style to the text, or it can be animated using the Position on Path control that appears when this mode is selected.
Center X, Y, and Z
These controls are used to position the center of the layout. For instance, moving the center X, Y, and Z parameters when the layout is set to Frame moves the position of the frame the text is within.

Size
This slider is used to control the scale of the layout element. For instance, increasing size when the layout is set to Frame increases the frame size the text is within.

Width and Height
The Width and Height controls are visible when the Layout mode is set to Circle or Frame. The Width and Height controls are visible only when the Layout mode is set to Frame. They are used to adjust the dimensions and aspect of the Layout element.

Rotation Order
These buttons allow you to select the order in which 3D rotations are applied to the text.

X, Y, and Z
These angle controls can be used to adjust the angle of the Layout element along any axis.

Fit Characters
This menu control is visible only when the Layout type is set to Circle. This menu is used to select how the characters are spaced to fit along the circumference.

Position on Path
The Position on Path control is used to control the position of the text along the path. Values less than zero or greater than one cause the text to move beyond, continuing in the same direction set by the last two points on the path.

Right-Click Here for Shape Animation
This label appears only when the Layout type is set to Path. It is used to provide access to a contextual menu that provides options for connecting the path to other paths in the node tree, and animating the spline points on the path over time.

Transform Tab
There are actually two Transform tabs in the Text 3D Inspector. The first Transform tab is unique to the Text 3D tool, while the second is the common Transform tab found on many 3D nodes. The Text 3D-specific Transform tab is described below since it contains some unique controls for this node.

Text 3D Transform tab

Transform
This menu determines the portion of the text affected by the transformations applied in this tab. Transformations can be applied to line, word, and character levels simultaneously. This menu is only used to keep the number of visible controls to a reasonable number.
– **Characters:** Each character of text is transformed along its own center axis.
– **Words:** Each word is transformed separately on the word’s center axis.
– **Lines:** Each line of the text is transformed separately on that line’s center axis.

**Spacing**
The Spacing slider is used to adjust the amount of space between each line, word, or character. Values less than one usually cause the characters to begin overlapping.

**Pivot X, Y, and Z**
This provides control over the exact position of the axis. By default, the axis is positioned at the calculated center of the line, word, or character. The pivot control works as an offset, such that a value of 0.1, 0.1 in this control would cause the axis to be shifted downward and to the right for each of the text elements. Positive values in the Z-axis slider move the axis further along the axis (away from the viewer). Negative values bring the axis of rotation closer.

**Rotation Order**
These buttons are used to determine the order in which transforms are applied. X, Y, and Z would mean that the rotation is applied to X, then Y, and then Z.

**X, Y, and Z**
These controls can be used to adjust the angle of the text elements in any of the three dimensions.

**Shear X and Y**
Adjust these sliders to modify the slanting of the text elements along the X- and Y-axis.

**Size X and Y**
Adjust these sliders to modify the size of the text elements along the X- and Y-axis.

**Shading**
The Shading tab for the Text 3D node controls the overall appearance of the text and how lights affect its surface.
Opacity
Reducing the material’s opacity decreases the color and Alpha values of the specular and diffuse colors equally, making the material transparent and allowing hidden objects to be seen through the material.

Use One Material
Deselecting this option reveals a second set of Material controls for the beveled edge of the text.

Type
To use a solid color texture, select the Solid mode. Selecting the Image mode reveals a new external input on the node that can be connected to another 2D image.

Specular Color
Specular Color determines the color of light that reflects from a shiny surface. The more specular a material is, the glossier it appears. Surfaces like plastics and glass tend to have white specular highlights, whereas metallic surfaces like gold have specular highlights that tend to inherit their color from the material color. The basic shader material does not provide an input for textures to control the specularity of the object. Use nodes from the 3D Material category when more precise control is required over the specular appearance.

Specular Intensity
Specular Intensity controls the strength of the specular highlight. If the specular intensity texture port has a valid input, then this value is multiplied by the Alpha value of the input.

Specular Exponent
Specular Exponent controls the falloff of the specular highlight. The greater the value, the sharper the falloff, and the smoother and glossier the material appears. The basic shader material does not provide an input for textures to control the specular exponent of the object. Use nodes from the 3D Material category when more precise control is required over the specular exponent.

Image Source
This control determines the source of the texture applied to the material. If the option is set to Tool, then an input appears on the node that can be used to apply the output of a 2D node as the texture. Selecting Clip opens a file browser that can be used to select an image or image sequence from disk. The Brush option provides a list of clips found in the Fusion\brushes folder.

Bevel Material
This option appears only when the Use One Material checkbox control is selected. The controls under this option are an exact copy of the Material controls above but are applied only to the beveled edge of the text.

Position, Rotation, Shear, and Size
These transform controls act similarly to the transform controls in the Transform tab when a single shading element is enabled from the top of the Shading tab. However, when two or more shading elements are enabled, these transform controls are applied to the currently selected shading element. This allows you to independently control the position, rotation, shearing, and size of borders, fill colors, and shadows.

Uncapped 3D Text
To hide the front face of extruded text, uncheck Use One Material on the Shading tab and reduce the first material’s color to black, including its Alpha value.
Common Controls

Transform and Settings Tabs
The Transform and Settings tabs in the Inspector are duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Text 3D Modifiers
Right-clicking within the Styled Text box displays a menu with the following text modifiers. Only one modifier can be applied to a Text 3D Styled Text box. Below is a brief list of the text specific modifiers, but for more information see Chapter 122, “Modifiers” in the DaVinci Resolve Reference Manual or Chapter 61 in the Fusion Reference Manual.

Animate
Use the Animate command to set to a keyframe on the entered text and animate the content over time.

Character Level Styling
The Text 3D node doesn’t support Character Level Styling directly. However, you can create a Text+ node first and modify its text field with a Character Level Styling modifier. Then either connect the Text 3D’s text field to the modifier that is now available or copy the Text+ node and paste its settings to the Text 3D node (right-click > Paste Settings)

Comp Name
Comp Name puts the name of the composition in the Styled Text box and is generally used as a quick way to create slates.

Follower
Follower is a text modifier that can be used to ripple animation applied to the text across each character in the text. See “Text Modifiers” at the end of this chapter.

Publish
Publish the text for connection to other text nodes.

Text Scramble
A text modifier ID is used to randomize the characters in the text. See “Text Modifiers” at the end of this chapter.

Text Timer
A text modifier is used to count down from a specified time or to output the current date and time. See “Text Modifiers” at the end of this chapter.

Time Code
A text modifier is used to output Time Code for the current frame. See “Text Modifiers” at the end of this chapter.

Connect To
Use this option to connect the text generated by this Text node to the published output of another node.
Transform 3D [3XF]

The Transform 3D node

Transform 3D Node Introduction

The Transform 3D node can be used to translate, rotate, or scale all the elements within a scene without requiring a Merge 3D node. This can be useful for hierarchical transformations or for offsetting objects that are merged into a scene multiple times. Its controls are identical to those found in other 3D nodes’ Transformation tabs.

Inputs

The Transform node has a single required input for a 3D scene or 3D object.

- **Scene Input:** The orange scene input is connected to a 3D scene or 3D object to apply a second set of transformation controls.

Basic Node Setup

The Transform 3D node adds 3D position, rotation, and pivot control onto any existing transforms in the 3D node prior to it. You can combine multiple Transform 3D nodes together to build parenting or hierarchical movement.

Transform 3D nodes strung together to create a parenting hierarchy
Controls Tab

The Controls tab is the primary tab for the Transform 3D node. It includes controls to translate, rotate, or scale all elements within a scene without requiring a Merge 3D node.

Translation

- **X, Y, Z Offset**: Controls are used to position the 3D element in 3D space.

Rotation

- **Rotation Order**: Use these buttons to select the order used to apply the rotation along each axis of the object. For example, XYZ would apply the rotation to the X-axis first, followed by the Y-axis, and then the Z-axis.

- **X, Y, Z Rotation**: Use these controls to rotate the object around its pivot point. If the Use Target checkbox is selected, then the rotation is relative to the position of the target; otherwise, the global axis is used.

Pivot Controls

- **X, Y, Z Pivot**: A pivot point is the point around which an object rotates. Normally, an object rotates around its own center, which is considered to be a pivot of 0,0,0. These controls can be used to offset the pivot from the center.

Scale

- **X, Y, Z Scale**: If the Lock X/Y/Z checkbox is checked, a single scale slider is shown. This adjusts the overall size of the object. If the Lock checkbox is unchecked, individual X, Y, and Z sliders are displayed to allow scaling in any dimension.

**NOTE**: If the Lock checkbox is checked, scaling of individual dimensions is not possible, even when dragging specific axes of the Transformation widget in Scale mode.
Use Target
Selecting the Use Target checkbox enables a set of controls for positioning an XYZ target. When Use Target is enabled, the object always rotates to face the target. The rotation of the object becomes relative to the target.

Import Transform
Opens a file browser where you can select a scene file saved or exported by your 3D application. It supports the following file types:

<table>
<thead>
<tr>
<th>Format</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>LightWave Scene</td>
<td>.lws</td>
</tr>
<tr>
<td>Max Scene</td>
<td>.ase</td>
</tr>
<tr>
<td>Maya Ascii Scene</td>
<td>.ma</td>
</tr>
<tr>
<td>dotXSI</td>
<td>.xsi</td>
</tr>
</tbody>
</table>

The Import Transform button imports only transformation data. For 3D geometry, lights and cameras, consider using the File > FBX Import option from the menus.

Onscreen Transformation Controls
Onscreen Transformation controls provide an alternative way of using the controls in the Inspector. The viewer includes modes for transformation, rotation, and scaling. To change the mode of the onscreen controls, select one of the three buttons in the toolbar along the side of the viewer. The modes can also be toggled using the keyboard shortcut Q for translation, W for rotation, and E for scaling. In all three modes, an individual axis of the control may be dragged to affect just that axis, or the center of the control may be dragged to affect all three axes.

The scale sliders for most 3D nodes default to locked, which causes uniform scaling of all three axes. Unlock the Lock X/Y/Z Scale checkbox to scale an object on a single axis only.
Triangulate 3D [3TRI]

The Triangulate 3D node

Triangulate 3D Node Introduction
The Triangulate 3D node is a unique node in that it has no controls. This node turns polygon shapes into triangles. For instance, a quad that is four points becomes two triangles. It is used to convert complex polygon shapes into a mesh for easier processing.

Inputs
The Triangulate 3D node has a single required input for a 3D scene or 3D object.

– **Scene Input**: The orange scene input is connected to the 3D scene or 3D object you want to triangulate.

Basic Node Setup
The Triangulate 3D node is placed after the geometry you want to triangulate.

Inspector

Triangulate 3D controls

Controls Tab
There are no controls for this node.
Common Controls

Settings Tab
The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

UV Map 3D [3UV]

UV Map 3D Node Introduction
The UV Map 3D node replaces the UV texture coordinates on the geometry in the scene. These coordinates tell Fusion how to apply a texture to an object. While it is possible to adjust the global properties of the selected mapping mode, it is not possible to manipulate the UV coordinates of individual vertices directly from within Fusion. The onscreen controls drawn in the viewers are for reference only and cannot be manipulated.

Camera Projections with UV Map 3D
The Camera Mapping mode makes it possible to project texture coordinates onto geometry through a camera. Once you select Camera from the Mapping mode menu, then connect the Camera 3D node that you want to use to create the UV coordinates.

Note that this does not directly project an image through the camera. The image to be projected should be connected to the diffuse texture input of whatever material is assigned to the objects. When the texture is applied, it uses the UV coordinates created by the camera. Because this is a texture projection and not light, the Alpha channel of the texture correctly sets the opacity of the geometry.

See the Camera 3D and Projector 3D nodes for alternate approaches to projection.

The projection can optionally be locked to the vertices as it appears on a selected frame.

This fails if the number of vertices in the mesh changes over time, as Fusion must be able to match up the mesh at the reference time and the current time. To be more specific, vertices may not be created or destroyed or reordered. So, projection locking does not work for many particle systems, or for primitives with animated subdivisions, or with duplicate nodes using non-zero time offsets.

NOTE: The UV Map 3D node does not put a texture or material on the mesh; it only modifies the texture coordinates that the materials use. This may be confusing because the material usually sits upstream, as seen in the Basic Node Setup example below.
Inputs

The UV Map 3D node has two inputs: one for a 3D scene or 3D object and another optional input for a Camera 3D node.

- **Scene Input**: The orange scene input is connected to the 3D scene or 3D object you want to triangulate.
- **Camera Input**: This input expects the output of the Camera 3D node. It is only visible when the Camera Map mode menu is set to Camera.

Basic Node Setup

The UV Map 3D node is placed after all the geometry and set to Camera Map. Connecting a camera to the UV map allows you to line up the texture based on a centered camera position and 3D geometry.

Inspector

UV Map 3D controls

Controls Tab

The UV Map 3D Controls tab allows you to select Planar, Cylindrical, Spherical, XYZ, and Cubic mapping modes, which can be applied to basic Fusion primitives as well as imported geometry. The position, rotation, and scale of the texture coordinates can be adjusted to allow fine control over the
texture's appearance. An option is also provided to lock the UV produced by this node to animated geometry according to a reference frame. This can be used to ensure that textures applied to animated geometry do not slide.

**Map Mode**

The Map mode menu is used to define how the texture coordinates are created. You can think of this menu as a way to select the virtual geometry that projects the UV space on the object.

- **Planar**: Creates the UV coordinates using a plane.
- **Cylindrical**: Creates the UV coordinates using a cylindrical-shaped object.
- **Spherical**: The UVs are created using a sphere.
- **XYZ to UVW**: The position coordinates of the vertices are converted to UVW coordinates directly. This is used for working with procedural textures.
- **CubeMap**: The UVs are created using a cube.
- **Camera**: Enables the Camera input on the node. After connecting a camera to the node, the texture coordinates are created based on camera projection.

**Orientation X/Y/Z**

Defines the reference axis for aligning the Map mode.

**Fit**

Clicking this button fits the Map mode to the bounding box of the input scene.

**Center**

Clicking this button moves the center of the Map mode to the bounding box center of the input scene.

**Lock UVs on Animated Objects**

If the object is animated, the UVs can be locked to it by enabling this option. The option also reveals the Ref Time slider, where it is possible to choose a reference frame for the UV mapping. Using this feature, it is not required to animate the UV map parameters. It is enough to set up the UV map at the reference time.

**Size X/Y/Z**

Defines the size of the projection object.

**Center X/Y/Z**

Defines the position of the projection object.

**Rotation/Rotation Order**

Use these buttons to select which order is used to apply the rotation along each axis of the object. For example, XYZ would apply the rotation to the X-axis first, followed by the Y-axis, and then the Z-axis.

**Rotation X/Y/Z**

Sets the orientation of the projection object for each axis, independent from the rotation order.

**Tile U/V/W**

Defines how often a texture fits into the projected UV space on the applicable axis. Note that the UVW coordinates are transformed, not a texture. This works best when used in conjunction with the Create Texture node.

**Flip U/V/W**

Mirrors the texture coordinates around the applicable axis.
Flip Faces (Cube Map Mode Only)
Mirrors the texture coordinates on the individual faces of the cube.

**NOTE:** To utilize the full capabilities of the UV Map 3D node, it helps to have a basic understanding of how 2D images are mapped onto 3D geometry. When a 2D image is applied to a 3D surface, it is converted into a texture map that uses UV coordinates to determine how the image translates to the object. Each vertex on a mesh has a (U, V) texture coordinate pair that describes the appearance the object takes when it is unwrapped and flattened. Different mapping modes use different methods for working out how the vertices transform into a flat 2D texture. When using the UV Map 3D node to modify the texture coordinates on a mesh, it’s best to do so using the default coordinate system of the mesh or primitive. So the typical workflow would look like Shape 3D > UV Map 3D > Transform 3D. The Transformation tab on the Shape node would be left to its default values, and the Transform 3D node following the UV Map 3D does any adjustments needed to place the node in the scene. Modifying/animating the transform of the Shape node causes the texture to slide across the shape, which is generally undesirable. The UV Map 3D node modifies texture coordinates per vertex and not per pixel. If the geometry the UV map is applied to is poorly tessellated, then undesirable artifacts may appear.

Common Controls

**Settings Tab**
The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

**Weld 3D [3WE]**

The Weld 3D node

**Weld 3D Node Introduction**
Sometimes 3D geometry has vertices that should have been joined when the geometry was created, but for one reason or another they are not joined. This can cause artifacts, especially when the two vertices have different normals.

For example, you may find:

- The different normals produce hard shading/lighting edges where none were intended.
- If you try to Displace 3D the vertices along their normals, they crack.
- Missing pixels or doubled-up pixels in the rendered image.
- Particles pass through the tiny invisible cracks.

Instead of round tripping back to your 3D modeling application to fix the “duplicated” vertices, the Weld 3D node allows you to do this in Fusion. Weld 3D welds together vertices with the same or nearly the same positions. This can be used to fix cracking issues when vertices are displaced by
welding the geometry before the Displace. There are no user controls to pick vertices. Currently, this node welds together just position vertices; it does not weld normals, texcoords, or any other vertex stream. So, although the positions of two vertices have been made the same, their normals still have their old values. This can lead to hard edges in certain situations.

**Inputs**

The Weld 3D node has a single input for a 3D scene or 3D object you want to repair.

- **Scene Input**: The orange scene input is connected to the 3D scene or 3D object you want to fix.

**Basic Node Setup**

The Weld 3D node is placed after the geometry that has duplicate vertices problems. Sometimes problems are exposed when displacing the geometry. In that case, placing the weld after the geometry but before the Displace 3D can repair the issues.

**Inspector**

Weld 3D controls

**Controls Tab**

The Controls tab for the Weld 3D node includes a simple Weld Mode menu. You can choose between welding vertices or fracturing them.

**Fracture**

Fracturing is the opposite of welding, so all vertices are unwelded. This means that all polygon adjacency information is lost. For example, an Image Plane 3D normally consists of connected quads that share vertices. Fracturing the image plane causes it to become a bunch of unconnected quads.

**Tolerance**

In auto mode, the Tolerance value is automatically detected. This should work in most cases. It can also be adjusted manually if needed.
Usage

Use Weld 3D when issues occur with the geometry. Don’t use it everywhere just because it’s there, as it influences render time.

Weld 3D is intended to be used as a mesh robustness tool and not as a mesh editing tool to merge vertices. If you can see the gap between the vertices you want to weld in the 3D view, you are probably misusing Weld 3D. Unexpected things may happen when you do this; do so at your own peril.

Limitations

Setting the tolerance too large can cause edges/faces to collapse to points.

If your model has detail distributed over several orders of scale, picking a tolerance value can be hard or impossible.

For example, suppose you have a model of the International Space Station and there are lots of big polygons and lots of really tiny polygons. If you set the tolerance too large, small polygons that shouldn’t merge do; if you set the tolerance too small, some large polygons won’t be merged.

Vertices that are far from the origin can fail to merge correctly. This is because bignumber + epsilon can exactly equal bignumber in float math. This is one reason it may be best to merge in local coordinates and not in world coordinates.

Sometimes Weld 3D-ing a mesh can make things worse. Take Fusion’s cone, for instance. The top vertex of the cone is currently duplicated for each adjoining face, and they all have different normals. If you weld the cone, the top vertices merge and only have one normal, making the lighting look weird.

Weld 3D is not multithreaded.

Warning

Do not misuse Weld 3D to simplify (reduce the polygon count of) meshes. It is designed to efficiently weld vertices that differ by only very small values, like a 0.001 distance.

Common Controls

Settings Tab
The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.
Modifier

Coordinate Transform 3D

Because of the hierarchical nature of the Fusion 3D node tree, the original position of an object in the 3D scene often fails to indicate the current position of the object. For example, an image plane might initially have a position at 1, 2, 1, but then be scaled, offset, and rotated by other nodes further downstream in the 3D scene, ending up with an absolute location of 10, 20, 5.

This can complicate connecting an object further downstream in the composition directly to the position of an upstream object. The Coordinate Transform modifier can be added to any set of XYZ coordinate controls and calculate the current position of a given object at any point in the scene hierarchy.

To add a Coordinate Transform modifier, simply right-click a number field on any node and select Modify With/CoordTransform Position from the Controls’ contextual menu.

Inspector

Target Object

This control should be connected to the 3D node that produces the original coordinates to be transformed. To connect a node, drag and drop a node from the node tree into the Text Edit control, or right-click the control and select the node from the contextual menu. It is also possible to type the node’s name directly into the control.

Sub ID

The Sub ID slider can be used to target an individual sub-element of certain types of geometry, such as an individual character produced by a Text 3D node or a specific copy created by a Duplicate 3D node.

Scene Input

This control should be connected to the 3D node that outputs the scene containing the object at the new location. To connect a node, drag and drop a node from the node tree into the Text Edit control, or right-click the control and select an object from the Connect To submenu.
The Common Controls

Nodes that handle 3D geometry share several identical controls in the Inspector. This section describes controls that are common among 3D nodes.

Common Controls Tab

These controls are often displayed in the lower half of the Controls tab. They appear in nodes that create or contain 3D geometry.

Visibility

– **Visible**: If this option is enabled, the object is visible in the viewers and in final renders. When disabled, the object is not visible in the viewers nor is it rendered into the output image by the Renderer 3D node. Also, a non-visible object does not cast shadows.

– **Unseen by Cameras**: When the Unseen by Cameras checkbox is enabled, the object is visible in the viewers (unless the Visible checkbox is disabled), except when viewed through a camera. Also, the object is not rendered into the output image by the Renderer 3D node. However, shadows cast by an unseen object are still visible when rendered by the software renderer in the Renderer 3D node, though not by the OpenGL renderer.

– **Cull Front Face/Back Face**: Use these options to eliminate rendering and display of certain polygons in the geometry. If Cull Back Face is selected, polygons facing away from the camera are not rendered and do not cast shadows. If Cull Front Face is selected, polygons facing toward the camera are not rendered and do not cast shadows. Enabling both options has the same effect as disabling the Visible checkbox.

– **Suppress Aux Channels for Transparent Pixels**: In previous versions of Fusion, transparent pixels were excluded by the software and OpenGL render options in the Renderer 3D node. To be more specific, the software renderer excluded pixels with R,G,B,A set to 0, and the GL renderer excluded pixels with A set to 0. This is now optional. The reason you might want to do this is to get aux channels (e.g., Normals, Z, UVs) for the transparent areas. For example, suppose you want to replace the texture on a 3D element that is transparent in certain areas with a texture that is...
transparent in different areas. It would then be useful to have transparent areas set aux channels (particularly UVs). As another example, suppose you are adding depth of field. You probably do not want the Z-channel to be set on transparent areas, as this gives you a false depth. Also, keep in mind that the exclusion is based on the final pixel color including lighting, if it is on. So, if you have a specular highlight on a clear glass material, this checkbox does not affect it.

**Lighting**
- **Affected by Lights**: Disabling this checkbox causes lights in the scene to not affect the object. The object does not receive nor cast shadows, and it is shown at the full brightness of its color, texture, or material.
- **Shadow Caster**: Disabling this checkbox causes the object not to cast shadows on other objects in the scene.
- **Shadow Receiver**: Disabling this checkbox causes the object not to receive shadows cast by other objects in the scene.

**Matte**
Enabling the Is Matte option applies a special texture, causing the object to not only become invisible to the camera, but also making everything that appears directly behind the camera invisible as well. This option overrides all textures. For more information on Fog 3D and Soft Clipping, see Chapter 86, “3D Compositing Basics” in the DaVinci Resolve Reference Manual or Chapter 25 in the Fusion Reference Manual.

- **Is Matte**: When activated, objects whose pixels fall behind the matte object’s pixels in Z do not get rendered. Two additional options are displayed when the Is Matte checkbox is activated.
- **Opaque Alpha**: When the Is Matte checkbox is enabled, the Opaque Alpha checkbox sets the Alpha value of the matte object to 1.
- **Infinite Z**: This option sets the value in the Z-channel to infinite. This checkbox is visible only when the Is Matte option is enabled.

**Blend Mode**
A Blend mode specifies which method is used by the renderer when combining this object with the rest of the scene. The blend modes are essentially identical to those listed in the section for the 2D Merge node. For a detailed explanation of each mode, see the section for that node.

The blending modes were originally designed for use with 2D images. Using them in a lit 3D environment can produce undesirable results. For best results, use the Apply modes in unlit 3D scenes using the software option in the Renderer 3D node.

- **OpenGL Blend Mode**: Use this menu to select the blending mode that is used when the geometry is processed by the OpenGL renderer in the Renderer 3D node. This is also the mode used when viewing the object in the viewers. Currently the OpenGL renderer supports a limited number of blending modes.
- **Software Blend Mode**: Use this menu to select the blending mode that is used when the geometry is processed by the software renderer. Currently, the software renderer supports all the modes described in the Merge node documentation, except for the Dissolve mode.

**Normal/Tangents**
Normals are imaginary lines perpendicular to each point on the surface of an object. They are used to illustrate the exact direction and orientation of every polygon on 3D geometry. Knowing the direction and orientation determines how the object gets shaded. Tangents are lines that exists along the surface’s plane. These lines are tangent to a point on the surface. The tangent lines are used to describe the direction of textures you apply to the surface of 3D geometry.

- **Scale**: This slider increases or decreases the length of the vectors for both normals and tangents.
– **Show Normals**: Displays blue vectors typically extending outside the surface of the geometry. These normal vectors help indicate how different areas of the surface are illuminated based on the angle at which the light hits it.

– **Show Tangents**: Displays green vectors for Y and red vectors of X. The X and Y vectors represent the direction of the image or texture you are applying to the geometry.

**Object ID**

Use this slider to select which ID is used to create a mask from the object of an image. Use the Sample button in the same way as the Color Picker to grab IDs from the image displayed in the viewer. The image or sequence must have been rendered from a 3D software package with those channels included.

**Common Materials Tab**

The controls in the Materials tab are used to determine the appearance of the 3D object when lit. Most of these controls directly affect how the object interacts with light using a basic shader. For more advanced control over the objects appearance, you can use tools from the 3D Materials category of the Effects Library. These tools can be used to assemble a more finely detailed and precise shader.

When a shader is constructed using the 3D Material tools and connected to the 3D Object's material input, the controls in this tab are replaced by a label that indicates that an external material is currently in use.
Diffuse
Diffuse describes the base surface characteristics without any additional effects like reflections or specular highlights.

**Diffuse Color**
The Diffuse Color determines the basic color of an object when the surface of that object is either lit indirectly or lit by an ambient light. If a valid image is provided to the tools diffuse texture input, then the RGB values provided here are also multiplied by the color values of the pixels in the diffuse texture. The Alpha channel of the diffuse material can be used to control the transparency of the surface.

**Alpha**
This slider sets the material’s Alpha channel value. This affects diffuse and specular colors equally, and affects the Alpha value of the material in the rendered output. If the tools diffuse texture input is used, then the Alpha value provided here is multiplied by the Alpha channel of the pixels in the image.

**Opacity**
Reducing the material’s Opacity decreases the color and Alpha values of the specular and diffuse colors equally, making the material transparent and allowing hidden objects to be seen through the material.

**Specular**
The Specular section provides controls for determining the characteristics of light that reflects toward the viewer. These controls affect the appearance of the specular highlight that appears on the surface of the object.

**Specular Color**
Specular Color determines the color of light that reflects from a shiny surface. The more specular a material is, the glossier it appears. Surfaces like plastics and glass tend to have white specular highlights, whereas metallic surfaces like gold have specular highlights that tend to inherit their color from the material color. The basic shader material does not provide an input for textures to control the specularity of the object. Use tools from the 3D Material category when more precise control is required over the specular appearance.

**Specular Intensity**
Specular Intensity controls how strong the specular highlight is. If the specular intensity texture input has a valid connection, then this value is multiplied by the Alpha value of the input.

**Specular Exponent**
Specular Exponent controls the falloff of the specular highlight. The greater the value, the sharper the falloff, and the smoother and glossier the material appears. The basic shader material does not provide an input for textures to control the specular exponent of the object. Use tools from the 3D Material category when more precise control is required over the specular exponent.

**Transmittance**
Transmittance controls the way light passes through a material. For example, a solid blue sphere casts a black shadow, but one made of translucent blue plastic would cast a much lower density blue shadow.

There is a separate opacity option. Opacity determines how transparent the actual surface is when it is rendered. Fusion allows adjusting both opacity and transmittance separately. This might be a bit counter-intuitive to artists who are unfamiliar with 3D software at first. It is possible to have a surface that is fully opaque but transmits 100% of the light arriving upon it, effectively making it a luminous/emissive surface.
Attenuation
Attenuation determines how much color is transmitted through the object. For an object to have transmissive shadows, set the attenuation to (1, 1, 1), which means 100% of green, blue, red light passes through the object. Setting this color to RGB (1, 0, 0) means that the material transmits 100% of the red arriving at the surface but none of the green or blue light. This allows “stained glass” shadows.

Alpha Detail
When the Alpha Detail slider is set to 0, the Alpha channel of the object is ignored and the entire object casts a shadow. If it is set to 1, the Alpha channel determines what portions of the object cast a shadow.

Color Detail
The Color Detail slider modulates light passing through the surface by the diffuse color + texture colors. Use this to throw a shadow that contains color details of the texture applied to the object. Increasing the slider from 0 to 1 brings in more of diffuse color + texture color into the shadow. Note that the Alpha and opacity of the object are ignored when transmitting color, allowing an object with a solid Alpha to still transmit its color to the shadow.

Saturation
The Saturation slider controls the saturation of the color component transmitted to the shadow. Setting this to 0.0 results in monochrome shadows.

Receives Lighting/Shadows
These checkboxes control whether the material is affected by lighting and shadows in the scene. If turned off, the object is always fully lit and/or unshadowed.

Two-Sided Lighting
This makes the surface effectively two-sided by adding a second set of normals facing the opposite direction on the back side of the surface. This is normally off, to increase rendering speed, but can be turned on for 2D surfaces or for objects that are not fully enclosed, to allow the reverse or interior surfaces to be visible as well.

Normally, in a 3D application, only the front face of a surface is visible and the back face is culled, so that if a camera were to revolve around a plane in a 3D application, when it reached the backside, the plane would become invisible. Making a plane two sided in a 3D application is equivalent to adding another plane on top of the first but rotated by 180 degrees so the normals are facing the opposite direction on the backside. Thus, when you revolve around the back, you see the second image plane that has its normals facing the opposite way.

Fusion does exactly the same thing as 3D applications when you make a surface two sided. The confusion about what two-sided lighting does arises because Fusion does not cull backfacing polygons by default. If you revolve around a one-sided plane in Fusion, you still see it from the backside (but you are seeing the frontside bits duplicated through to the backside as if it were transparent). Making the plane two sided effectively adds a second set of normals to the backside of the plane.

Note that this can become rather confusing once you make the surface transparent, as the same rules still apply and produce a result that is counterintuitive. If you view from the frontside a transparent two-sided surface illuminated from the backside, it looks unlit.

Material ID
This control is used to set the numeric identifier assigned to this material. The Material ID is an integer number that is rendered into the MatID auxiliary channel of the rendered image when the Material ID option is enabled in the Renderer 3D tool. For more information, see Chapter 86, “3D Compositing Basics” in the DaVinci Resolve Reference Manual or Chapter 25 in the Fusion Reference Manual.
Common Transform Tab

Many tools in the 3D category include a Transform tab used to position, rotate, and scale the object in 3D space.

**Translation**

**X, Y, Z Offset**

These controls can be used to position the 3D element.

**Rotation**

**Rotation Order**

Use these buttons to select which order is used to apply rotation along each axis of the object. For example, XYZ would apply the rotation to the X axis first, followed by the Y axis and then finally the Z axis.

**X, Y, Z Rotation**

Use these controls to rotate the object around its pivot point. If the Use Target checkbox is selected, then the rotation is relative to the position of the target; otherwise, the global axis is used.

**Pivot**

**X, Y, Z Pivot**

A Pivot point is the point around which an object rotates. Normally, an object rotates around its own center, which is considered to be a pivot of 0,0,0. These controls can be used to offset the pivot from the center.

**Scale**

**X, Y, Z Scale**

If the Lock X/Y/Z checkbox is checked, a single Scale slider is shown. This adjusts the overall size of the object. If the Lock checkbox is unchecked, individual X, Y, and Z sliders are displayed to allow individual scaling in each dimension. Note: If the Lock checkbox is checked, scaling of individual dimensions is not possible, even when dragging specific axes of the Transformation Widget in scale mode.
**Use Target**
Selecting the Use Target checkbox enables a set of controls for positioning an XYZ target. When target is enabled, the object always rotates to face the target. The rotation of the object becomes relative to the target.

**Import Transform**
Opens a file browser where you can select a scene file saved or exported by your 3D application. It supports the following file types:

<table>
<thead>
<tr>
<th>Format</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>LightWave Scene</td>
<td>.lws</td>
</tr>
<tr>
<td>Max Scene</td>
<td>.ase</td>
</tr>
<tr>
<td>Maya Ascii Scene</td>
<td>.ma</td>
</tr>
<tr>
<td>dotXSI</td>
<td>.xsi</td>
</tr>
</tbody>
</table>

The Import Transform button imports only transformation data. For 3D geometry, lights, and cameras, consider using the File > FBX Import option.

**Onscreen Transformation Controls**

Most of the controls in the Transform tab are represented in the viewer with onscreen controls for transformation, rotation, and scaling. To change the mode of the onscreen controls, select one of the three buttons in the toolbar in the upper left of the viewer. The modes can also be toggled using the keyboard shortcut Q for translation, W for rotation, and E for scaling. In all three modes, individual axes of the control may be dragged to affect just that axis, or the center of the control may be dragged to affect all three axes.

The scale sliders for most 3D tools default to locked, which causes uniform scaling of all three axes. Unlock the Lock X/Y/Z Scale checkbox to scale an object on a single axis only.

**Settings Tab**

Common Settings 3D controls
The Common Settings tab can be found on most tools in Fusion. The following controls are specific settings for 3D nodes.

**Hide Incoming Connections**
Enabling this checkbox can hide connection lines from incoming nodes, making a node tree appear cleaner and easier to read. When enabled, empty fields for each input on a node are displayed in the Inspector. Dragging a connected node from the node tree into the field hides that incoming connection line as long as the node is not selected in the node tree. When the node is selected in the node tree, the line reappears.

**Comment Tab**
The Comment tab contains a single text control that is used to add comments and notes to the tool. When a note is added to a tool, a small red dot icon appears next to the setting’s tab icon and a text bubble appears on the node. To see the note in the Node Editor, hold the mouse pointer over the node for a moment. The contents of the Comments tab can be animated over time, if required.

**Scripting Tab**
The Scripting tab is present on every tool in Fusion. It contains several edit boxes used to add scripts that process when the tool is rendering. For more details on the contents of this tab, please consult the scripting documentation.
Chapter 91

3D Light Nodes

This chapter details the 3D Light nodes available when creating 3D composites in Fusion. The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

<table>
<thead>
<tr>
<th>Node Type</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient Light [3AL]</td>
<td>1729</td>
</tr>
<tr>
<td>Directional Light [3DL]</td>
<td>1730</td>
</tr>
<tr>
<td>Point Light [3PL]</td>
<td>1732</td>
</tr>
<tr>
<td>Spot Light [3SL]</td>
<td>1734</td>
</tr>
<tr>
<td>The Common Controls</td>
<td>1738</td>
</tr>
</tbody>
</table>
Ambient Light Node Introduction

An Ambient Light is a directionless light that globally illuminates a scene. It has no real position or rotation, although an onscreen control appears in the viewer to indicate that a light is present in the scene. Position controls for the viewer are provided to move the widget out of the way of other geometry, if necessary.

Similar to a Camera 3D, you connect lights into a Merge 3D and view them in the scene by viewing the Merge 3D node. Selecting a light node and loading it into the viewer does not show anything.

Inputs

The Ambient Light node includes a single optional orange input for a 3D scene or 3D geometry.

- **SceneInput:** The orange input is an optional input that accepts a 3D scene. If a scene is provided, the Transform controls in this node apply to the entire scene provided.

Basic Node Setup

The Ambient Light node is designed to be part of a larger 3D scene. You connect the light directly into a Merge 3D. Separating lights into different Merge 3D nodes allows you to control which lights affect which objects.
Inspector

Ambient Light controls

Controls Tab
The Controls tab is used to set the color and brightness of the ambient light.

Enabled
When the Enabled checkbox is turned on, the ambient light affects the scene. When the checkbox to turned off, the light is turned off. This checkbox performs the same function as the red switch to the left of the node’s name in the Inspector.

Color
Use this standard Color control to set the color of the light.

Intensity
Use this slider to set the Intensity of the ambient light. A value of 0.2 indicates 20% percent light. A perfectly white texture lit only with a 0.2 ambient light would render at 20% gray (.2, .2, .2).

Common Controls

Transform and Settings Tabs
The options presented in the Transform and Settings tabs are commonly found in other lighting nodes. For more detail on the controls found in these tabs, see “The Common Controls” section at the end of this chapter.

Directional Light [3DL]

The Directional Light node
**Directional Light Node Introduction**

A directional light is a light with a clear direction but without a clear source or distance, similar to sunlight. This light shows an onscreen control, but the position of the control has no meaning. The rotation of the control is used to determine from where in the scene the light appears to be coming.

Similar to a Camera 3D, you connect lights into a Merge 3D and view them in the scene by viewing the Merge 3D node. Selecting a light node and loading it into the viewer does not show anything.

**Inputs**

The Directional Light node includes a single optional orange input for a 3D scene or 3D geometry.

- **SceneInput**: The orange input is an optional input that accepts a 3D scene. If a scene is provided, the Transform controls in this node apply to the entire scene provided.

**Basic Node Setup**

The Directional Light node is designed to be part of a larger 3D scene. You connect the light directly into a Merge 3D. Separating lights into different Merge 3D nodes allows you to control which lights affect which objects.

**Inspector**

Directional Light controls
Controls Tab
The Controls tab is used to set the color and brightness of the directional light. The direction of the light source is controlled by the rotation controls in the Transform tab.

Enabled
When the Enabled checkbox is turned on, the directional light affects the scene. When the checkbox is turned off, the light is turned off. This checkbox performs the same function as the red switch to the left of the node’s name in the Inspector.

Color
Use this standard Color control to set the color of the light.

Intensity
Use this slider to set the Intensity of the directional light. A value of 0.2 indicates 20% percent light.

Common Controls

Transform and Settings Tabs
The options presented in the Transform and Settings tabs are commonly found in other lighting nodes. For more detail on the controls found in these tabs, see “The Common Controls” section at the end of this chapter.

Point Light [3PL]

Point Light Node Introduction
A point light is a light source with a clear position in space that emits light in all directions. A light bulb is a good example of a point light.

This light shows an onscreen control, although only the position and distance of the control affect the light. Since the light is a 360-degree source, rotation has no meaning. Additionally, a point light may fall off with distance, unlike an ambient or directional light.

Similar to a Camera 3D, you connect lights into a Merge 3D and view them in the scene by viewing the Merge 3D node. Selecting a light node and loading it into the viewer does not show anything.

Inputs
The Point Light node includes a single optional orange input for a 3D scene or 3D geometry.

– SceneInput: The orange input is an optional input that accepts a 3D scene. If a scene is provided, the Transform controls in this node apply to the entire scene provided.

Basic Node Setup
The Point Light node is designed to be part of a larger 3D scene. You connect the light directly into a Merge 3D. Separating lights into different Merge 3D nodes allows you to control which lights affect which objects.
The Controls tab is used to set the color and brightness of the point light. The position and distance of the light source are controlled in the Transform tab.

**Enabled**
When the Enabled checkbox is turned on, the point light affects the scene. When the checkbox is turned off the light is turned off. This checkbox performs the same function as the red switch to the left of the node's name in the Inspector.

**Color**
Use this standard Color control to set the color of the light.

**Intensity**
Use this slider to set the Intensity of the point light. A value of 0.2 indicates 20% percent light.

**Decay Type**
A point light defaults to No Decay, meaning that its light has equal intensity at all points in the scene. To cause the intensity to fall off with distance, set the Decay Type to either Linear or Quadratic modes.
Common Controls

Transform and Settings Tabs
The options presented in the Transform and Settings tabs are commonly found in other lighting nodes. For more detail on the controls found in these tabs, see "The Common Controls" section at the end of this chapter.

Spot Light [3SL]

Spot Light Node Introduction
A spotlight is a light that comes from a specific point and that has a clearly defined cone, with falloff of the light to the edges. Experienced stage and theatre lighting technicians may recognize the spotlight as being very similar to practical lights used in live productions. This is the only type of light capable of casting shadows.

Similar to a Camera 3D, you connect lights into a Merge 3D and view them in the scene by viewing the Merge 3D node. Selecting a light node and loading it into the viewer does not show anything.

Inputs
The Spot Light node includes a single optional orange input for a 3D scene or 3D geometry.

– ScenInput: The orange input is an optional input that accepts a 3D scene. If a scene is provided, the Transform controls in this node apply to the entire scene provided.

Basic Node Setup
The Spot Light node is designed to be part of a larger 3D scene. You connect the light directly into a Merge 3D. Separating lights into different Merge 3D nodes allows you to control which lights affect which objects.
Inspector

Controls Tab

The Controls tab is used to set the color and brightness of the spotlight. The position, rotation, and distance of the light source are controlled in the Transform tab.

Enabled

When the Enabled checkbox is turned on, the spotlight affects the scene. When the checkbox is turned off the light is turned off. This checkbox performs the same function as the red switch to the left of the node’s name in the Inspector.

Color

Use this standard Color control to set the color of the light.

Intensity

Use this slider to set the Intensity of the spot light. A value of 0.2 indicates 20% percent light.

Decay Type

A spotlight defaults to No Falloff, meaning that its light has equal intensity on geometry despite the distance from the light to the geometry. To cause the intensity to fall off with distance, set the Decay type to either Linear or Quadratic modes.

Cone Angle

The Cone Angle of the light refers to the width of the cone where the light emits its full intensity. The larger the angle, the wider the cone angle, up to a limit of 90 degrees.

Penumbra Angle

The Penumbra Angle determines the area beyond the cone angle where the light’s intensity falls off toward 0. A larger penumbra angle defines a larger falloff, while a value of 0 generates a hard-edged light.
**Dropoff**
The Dropoff controls how quickly the penumbra angle falls off from full intensity to 0.

**Shadows**
This section provides several controls used to define the shadow map used when this spotlight creates shadows. For more information, see Chapter 25, “3D Compositing Basics” in the Fusion Reference Manual or Chapter 86 in the DaVinci Resolve Reference Manual.

**Enable Shadows**
The Enable Shadows checkbox should be selected if the light is to produce shadows. This defaults to selected.

**Shadow Color**
Use this standard Color control to set the color of the shadow. This defaults to black (0, 0, 0).

**Density**
The shadow density determines the transparency of the shadow. A density of 1.0 produces a completely opaque shadow, whereas lower values make the shadow more transparent.

**Shadow Map Size**
The Shadow Map Size control determines the size of the bitmap used to create the shadow map. Larger values produce more detailed shadow maps at the expense of memory and performance.

**Shadow Map Proxy**
Shadow Map Proxy determines the size of the shadow map used when the Proxy or Auto Proxy modes are enabled. A value of 0.5 would produce a shadow map at half the resolution defined in the Shadow Map Size.

**Multiplicative/Additive Bias**
Shadows are essentially textures applied to objects in the scene, so there is occasionally Z-fighting, where the portions of the object that should be receiving the shadows render over the top of the shadow. Biasing works by adding a small depth offset to move the shadow away from the surface it is shadowing, eliminating the Z-fighting. Too little bias and the objects can self-shadow themselves. Too much bias and the shadow can become separated from the surface. Adjust the Multiplicative Bias first, and then fine tune the result using the Additive Bias control.

For more information, see the Multiplicative and Additive Bias section of Chapter 86, “3D Compositing” in the DaVinci Resolve Reference Manual, or Chapter 25 in the Fusion Reference Manual.

**Force All Materials Non-Transmissive**
Normally, an RGBAZ shadow map is used when rendering shadows. By enabling this option, you are forcing the renderer to use a Z-only shadow map. This can lead to significantly faster shadow rendering while using a fifth as much memory. The disadvantage is that you can no longer cast "stained glass"-like shadows.

**Shadow Map Sampling**
Sets the quality for sampling of the shadow map.

**Softness**
Soft edges in shadows are produced by filtering the shadow map when it is sampled. Fusion provides two separate filtering methods for rendering shadows, which produce different effects.
NOTE: Shadows have a hard edge. No filtering of the shadow map is done at all. The advantage of this method is that you only have to sample one pixel in the shadow map, so it is fast.

- **Constant**: Shadows edges have a constant softness. A filter with a constant width is used when sampling the shadow map. Adjusting the Constant Softness slider controls the size of the filter. Note that the larger you make the filter, the longer it takes to render the shadows.

- **Variable**: The shadow edge softness grows the further the shadow receiver is positioned from the shadow caster. The variable softness is achieved by changing the size of the filter based on the distance between the receiver and caster. When this option is selected, the Softness Falloff, Min Softness, and Max Softness sliders appear.

**Constant Softness**
If the Softness is set to Constant, then this slider appears. It can be used to set the overall softness of the shadow.

**Softness Falloff**
The Softness Falloff slider appears when the Softness is set to variable. This slider controls how fast the softness of shadow edges grows with distance. More precisely, it controls how fast the shadow map filter size grows based upon the distance between the shadow caster and receiver. Its effect is mediated by the values of the Min and Max Softness sliders.

**Min Softness**
The Min Softness slider appears when the Softness is set to Variable. This slider controls the Minimum Softness of the shadow. The closer the shadow is to the object casting the shadow, the sharper it is, up to the limit set by this slider.

**Max Softness**
The Max Softness slider appears when the Softness is set to Variable. This slider controls the Maximum Softness of the shadow. The further the shadow is from the object casting the shadow, the softer it is, up to the limit set by this slider.

**Common Controls**

**Transform and Settings Tabs**
The options presented in the Transform and Settings tabs are commonly found in other lighting nodes. For more detailed information on the controls found in these tabs, see "The Common Controls" section at the end of this chapter.
The Common Controls

Nodes that handle 3D lighting share several identical controls in the Inspector. This section describes controls that are common among 3D lighting nodes.

Common Transform Tab

Many tools in the 3D category include a Transform tab used to position, rotate, and scale the object in 3D space.

Translation

X, Y, Z Offset

These controls can be used to position the 3D element.

Rotation

Rotation Order

Use these buttons to select which order is used to apply Rotation along each axis of the object. For example, XYZ would apply the rotation to the X axis first, followed by the Y axis, and finally the Z axis.

X, Y, Z Rotation

Use these controls to rotate the object around its pivot point. If the Use Target checkbox is selected, then the rotation is relative to the position of the target; otherwise, the global axis is used.

Pivot

X, Y, Z Pivot

A pivot point is the point around which an object rotates. Normally, an object rotates around its own center, which is considered to be a pivot of 0,0,0. These controls can be used to offset the pivot from the center.
Scale

X, Y, Z Scale
If the Lock X/Y/Z checkbox is checked, a single Scale slider is shown. This adjusts the overall size of the object. If the Lock checkbox is unchecked, individual X, Y, and Z sliders are displayed to allow individual scaling in each dimension. Note: If the Lock checkbox is checked, scaling of individual dimensions is not possible, even when dragging specific axes of the Transformation Widget in scale mode.

Use Target
Selecting the Use Target checkbox enables a set of controls for positioning an XYZ target. When Target is enabled, the object always rotates to face the target. The rotation of the object becomes relative to the target.

Import Transform
Opens a file browser where you can select a scene file saved or exported by your 3D application. It supports the following file types:

<table>
<thead>
<tr>
<th>Format</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>LightWave Scene</td>
<td>.lws</td>
</tr>
<tr>
<td>Max Scene</td>
<td>.ase</td>
</tr>
<tr>
<td>Maya Ascii Scene</td>
<td>.ma</td>
</tr>
<tr>
<td>dotXSI</td>
<td>.xsi</td>
</tr>
</tbody>
</table>

The Import Transform button imports only transformation data. For 3D geometry, lights, and cameras, consider using the File > FBX Import option.

Onscreen Transformation Controls

Viewer Transform buttons.
Most of the controls in the Transform tab are represented in the viewer with onscreen controls for transformation, rotation, and scaling. To change the mode of the onscreen controls, select one of the three buttons in the toolbar in the upper left of the viewer. The modes can also be toggled using the keyboard shortcut Q for translation, W for rotation, and E for scaling. In all three modes, individual axes of the control may be dragged to affect just that axis, or the center of the control may be dragged to affect all three axes.

The Scale sliders for most 3D tools default to locked, which causes uniform scaling of all three axes. Unlock the Lock X/Y/Z Scale checkbox to scale an object on a single axis only.
The Common Settings tab can be found on almost every tool found in Fusion. The following controls are specific settings for 3D nodes.

**Hide Incoming Connections**
Enabling this checkbox can hide connection lines from incoming nodes, making a node tree appear cleaner and easier to read. When enabled, fields for each input on a node are displayed. Dragging a connected node from the node tree into the field hides that incoming connection line as long as the node is not selected in the node tree. When the node is selected in the node tree, the line reappears.

**Comment Tab**
The Comment tab contains a single text control that is used to add comments and notes to the tool. When a note is added to a tool, a small red dot icon appears next to the setting's tab icon, and a text bubble appears on the node. To see the note in the Node Editor, hold the mouse pointer over the node for a moment. The contents of the Comments tab can be animated over time, if required.

**Scripting Tab**
The Scripting tab is present on every tool in Fusion. It contains several edit boxes used to add scripts that process when the tool is rendering. For more details on the contents of this tab, please consult the scripting documentation.
This chapter details the 3D Material nodes available when creating 3D composites in Fusion. The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

- Blinn [3BI] 1742
- Channel Boolean [3BOL] 1746
- Cook Torrance [3CT] 1749
- Material Merge 3D [3MM] 1753
- Phong [3PH] 1754
- Reflect [3RR] 1758
- Stereo Mix [3SMM] 1761
- Ward [3WD] 1763
- The Common Controls 1767
**Blinn Node Introduction**

The Blinn node is a basic illumination material that can be applied to geometry in the 3D scene. It describes how the object responds to light and provides multiple texture map inputs to allow fine control over the diffuse, specular, and bump map components of the material.

The standard basic material provided in the Materials tab of most geometry nodes is a simplified version of the Blinn node. The primary difference is that the Blinn node provides additional texture map inputs beyond just diffuse.

The Blinn node outputs a 3D Material that can be connected to the material inputs on any 3D geometry node.

The Blinn model in Fusion calculates the highlight as the dot product of the surface normal and the half angle vector between light source and viewer (dot(N,H)). This may not always match the Blinn model illumination model used by other 3D applications.

**Inputs**

There are five inputs on the Blinn node that accept 2D images or 3D materials. These inputs control the overall color and image used for the 3D object as well as the color and texture used in the specular highlight. Each of these inputs multiplies the pixels in the texture map by the equivalently named parameters in the node itself. This provides an effective method for scaling parts of the material.

- **Diffuse Texture:** The orange Diffuse Texture input accepts a 2D image or a 3D material to be used as a main object texture map.
- **Specular Color Material:** The green Specular Color material input accepts a 2D image or a 3D material to be used as the color texture map for specula highlight areas.
- **Specular Intensity Materials:** The magenta Specular Intensity material input accepts a 2D image or a 3D material to be used to alter the intensity of specular highlights. When the input is a 2D image, the Alpha channel is used to create the map, while the color channels are discarded.
- **Specular Exponent Material:** The teal Specular Exponent material input accepts a 2D image or a 3D material that is used as a falloff map for the material’s specular highlights. When the input is a 2D image, the Alpha channel is used to create the map, while the color channels are discarded.
- **Bump Map Material:** The white Bump Map material input accepts only a 3D material. Typically, you connect the texture into a Bump Map node, and then connect the Bump Map node to this input. This input uses the RGB information as texture-space normals.
When nodes have as many inputs as this one does, it is often difficult to make connections with any precision. Hold down the Option (macOS) or Alt (Windows) key while dragging the output from another node over the node tile, and keep holding Option or Alt when releasing the left mouse button. A small drop-down menu listing all the inputs provided by the node appears. Click on the desired input to complete the connection. Alternatively, you can drag the output from a node with the right mouse button to activate the same menu.

**Basic Node Setup**

The output of a Blinn node output is connected to the material input on a 3D scene or 3D geometry node to which you want the shader applied. The Blinn inputs can use images as the diffuse color material (orange) and specular color material (green). This can lead to a smooth, shiny material.

![A Blinn shader with diffuse and specular color materials connected](image)

**Inspector**

The Controls tab is the primary tab for the Blinn node. It controls the color and shininess applied to the surface of the 3D geometry.

**Controls Tab**

The Controls tab is the primary tab for the Blinn node. It controls the color and shininess applied to the surface of the 3D geometry.
**Diffuse**
Diffuse describes the base surface characteristics without any additional effects like reflections or specular highlights. Besides defining the base color of an object, the diffuse color also defines the transparency of the object. The Alpha in a diffuse texture map can be used to make portions of the surface transparent.

**Diffuse Color**
A material's Diffuse Color describes the base color presented by the material when it is lit indirectly or by ambient light. If a diffuse texture map is provided, then the color value provided here is multiplied by the color values in the texture.

**Alpha**
This slider sets the material's Alpha channel value. This affects diffuse and specular colors equally and affects the Alpha value of the material in the rendered output. If a diffuse texture map is provided, then the Alpha value set here is multiplied by the Alpha values in the texture map.

**Opacity**
Reducing the material's opacity decreases the color and Alpha values of the specular and diffuse colors equally, making the material transparent.

**Specular**
The parameters in the Specular section describe the look of the specular highlight of the surface. These values are evaluated in a different way for each illumination model.

**Specular Color**
Specular Color determines the color of light that reflects from a shiny surface. The more specular a material is, the glossier it appears. Surfaces like plastics and glass tend to have white specular highlights, whereas metallic surfaces like gold have specular highlights that inherit their color from the material color. If a specular texture map is provided, then the value provided here is multiplied by the color values from the texture.

**Specular Intensity**
Specular Intensity controls how strong the specular highlight is. If the specular intensity texture is provided, then this value is multiplied by the Alpha value of the texture.

**Specular Exponent**
Specular Exponent controls the falloff of the specular highlight. The greater the value, the sharper the falloff, and the smoother and glossier the material appears. If the specular exponent texture is provided, then this value is multiplied by the Alpha value of the texture map.

**Transmittance**
Transmittance controls the way light passes through a material. For example, a solid blue sphere casts a black shadow, but one made of translucent blue plastic would cast a much lower density blue shadow.

There is a separate Opacity option. Opacity determines how transparent the actual surface is when it is rendered. Fusion allows adjusting both opacity and transmittance separately. At first, this might be a bit counterintuitive to those who are unfamiliar with 3D software. It is possible to have a surface that is fully opaque but transmits 100% of the light arriving upon it, effectively making it a luminous/ emissive surface.

**Attenuation**
Attenuation determines how much color is passed through the object. For an object to have transmissive shadows, set the attenuation to (1, 1, 1), which means 100% of green, blue, and red light passes through the object. Setting this color to RGB (1, 0, 0) means that the material transmits 100% of
the red arriving at the surface but none of the green or blue light. This can be used for "stained glass"-styled shadows.

**Alpha Detail**
When the Alpha Detail slider is set to 0, the Alpha channel of the object is ignored and the entire object casts a shadow. If it is set to 1, the Alpha channel determines what portions of the object cast a shadow.

**Color Detail**
The Color Detail slider modulates light passing through the surface by the diffuse color + texture colors. Use this to throw a shadow that contains color details of the texture applied to the object. Increasing the slider from 0 to 1 brings in more diffuse color + texture color into the shadow. Note that the Alpha and opacity of the object are ignored when transmitting color, allowing an object with a solid Alpha to still transmit its color to the shadow.

**Saturation**
The Saturation slider controls the saturation of the color component transmitted to the shadow. Setting this to 0.0 results in monochrome shadows.

**Receives Lighting/Shadows**
These checkboxes control whether the material is affected by lighting and shadows in the scene. If turned off, the object is always fully lit and/or unshadowed.

**Two-Sided Lighting**
This effectively makes the surface two sided by adding a second set of normals facing the opposite direction on the backside of the surface. This is normally off to increase rendering speed, but it can be turned on for 2D surfaces or for objects that are not fully enclosed, to allow the reverse or interior surfaces to be visible as well.

Normally, in a 3D application, only the front face of a surface is visible and the back face is culled, so that if a camera were to revolve around a plane in a 3D application, when it reached the backside, the plane would become invisible. Making a plane two sided in a 3D application is equivalent to adding another plane on top of the first but rotated by 180 degrees so the normals are facing the opposite direction on the backside. Thus, when you revolve around the back, you see the second image plane, which has its normals facing the opposite way.

Fusion does exactly the same thing as 3D applications when you make a surface two sided. The confusion about what two-sided lighting does arises because Fusion does not cull back-facing polygons by default. If you revolve around a one-sided plane in Fusion, you still see it from the backside (but you are seeing the frontside duplicated through to the backside as if it were transparent). Making the plane two sided effectively adds a second set of normals to the backside of the plane.

**NOTE:** This can become rather confusing once you make the surface transparent, as the same rules still apply and produce a result that is counterintuitive. If you view from the frontside a transparent two-sided surface illuminated from the backside, it looks unlit.

**Material ID**
This slider sets the numeric identifier assigned to this material. This value is rendered into the MatID auxiliary channel if the corresponding option is enabled in the renderer.

**Common Controls**

**Settings Tab**
The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.
The Channel Boolean (not to be confused with the 2D Channel Booleans) can be used to remap and modify channels of 3D materials using mathematical operations. For example, if you want to use the red channel of a material to control a scalar input of an illumination model that uses the Alpha channel (e.g., Blinn, SpecularExponent), you can remap the channels here. Furthermore, it allows the use of geometry-specific information like texture space coordinates and normals.

**Inputs**

There are two inputs on the Channel Boolean Node: one for the foreground material, and one for the background material. Both inputs accept either a 2D image or a 3D material like Blinn, Cook-Torrance, or Phong node.

- **BackgroundMaterial**: The orange background material input accepts a 2D image or a 3D material.
- **ForegroundMaterial**: The green foreground input also accepts a 2D image or a 3D material.

**Basic Node Setup**

There are many uses for the material 3D Channel Boolean. Most often it is used to combine material looks or manipulate UV texture coordinates.

In the below example, the Channel Boolean node combines the Cook Torrance and Blinn materials. It uses the math operands in the Channel Boolean to switch, invert, and mix the two inputs, creating a neon flickering effect.
Inspector

Controls Tab
The Controls tab includes a section for each RGBA channel. Within each channel are two input menus called Operand A and Operand B. The function performed on these two inputs is selected in the Operation menu.

Operand A/B
The Operand menus, one for each output RGBA channel, allow you to set the desired input information for the corresponding channel.

- **Red/Green/Blue/Alpha FG**
  Reads the color information of the foreground material.

- **Red/Green/Blue/Alpha BG**
  Reads the color information of the background material.

- **Black/White/Mid Gray**
  Sets the value of the channel to 0, 0.5, or 1.

- **Hue/Lightness/Saturation FG**
  Reads the color information of the foreground material, converts it into the HLS color space, and puts the selected information into the corresponding channel.

- **Hue/Lightness/Saturation BG**
  Reads the color information of the background material, converts it into the HLS color space, and puts the selected information into the corresponding channel.

- **Luminance FG**
  Reads the color information of the foreground material and calculates the luminance value for the channel.

- **Luminance BG**
Reads the color information of the background material and calculates the luminance value for the channel.

- **X/Y/Z Position FG**
  Sets the value of the channel to the position of the pixel in 3D space. The vector information is returned in eye space.

- **U/V/W Texture FG**
  Applies the texture space coordinates of the foreground material to the channels.

- **U/V/W EnvCoords FG**
  Applies the environment texture space coordinates to the channels. Use it upstream of nodes modifying the environment texture coordinates like the Reflect 3D node.

- **X/Y/Z Normal**
  Sets the value of the channel to the selected axis of the normal vector. The vector is returned in eye space.

**Operation**

Determines the Operation of how the operands are combined.

- **A:** Uses Operand A only for the output channel.
- **B:** Uses Operand B only for the output channel.
- **1-A:** Subtracts the value of Operand A from 1.
- **1-B:** Subtracts the value of Operand B from 1.
- **A+B:** Adds the value of Operand A and B.
- **A-B:** Subtracts the value of Operand B from A.
- **A*B:** Multiplies the value of both Operands.
- **A/B:** Divides the value of Operand B from A.
- **min(A,B):** Compares the values of Operands A and B and returns the smaller one.
- **max(A,B):** Compares the values of Operands A and B and returns the bigger one.
- **avg(A,B):** Returns the average value of both Operands.

**Material ID**

This slider sets the numeric identifier assigned to this material. This value is rendered into the MatID auxiliary channel if the corresponding option is enabled in the renderer.

**Common Controls**

**Settings Tab**

The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
Cook Torrance Node Introduction

The Cook Torrance node is a basic illumination material that can be applied to geometry in the 3D scene. The diffuse calculation for this node is similar to that used in the basic material and the Blinn node, but the specular highlights are evaluated using an optimized Fresnel/Beckmann equation. This illumination model is primarily used for shading metal or other shiny and highly reflective surfaces.

The Cook Torrance node outputs a 3D Material that can be connected to the material inputs on any 3D geometry node.

Inputs

There are six inputs on the Cook Torrance node that accept 2D images or 3D materials. These inputs control the overall color and image used for the 3D object as well as controlling the color and texture used in the specular highlight. Each of these inputs multiplies the pixels in the texture map by the equivalently named parameters in the node itself. This provides an effective method for scaling parts of the material.

- **Diffuse Color Material:** The orange Diffuse Color material input accepts a 2D image or a 3D material to be used as overall color and texture of the object.
- **Specular Color Material:** The green Specular Color material input accepts a 2D image or a 3D material to be used as the color and texture of the specular highlight.
- **Specular Intensity Material:** The magenta Specular Intensity material input accepts a 2D image or a 3D material to alter the intensity of the specular highlight. When the input is a 2D image, the Alpha channel is used to create the map, while the color channels are discarded.
- **Specular Roughness Material:** The white Specular Roughness material input accepts a 2D image or a 3D material to be used as a map for modifying the roughness of the specular highlight. The Alpha of the texture map is multiplied by the value of the roughness control.
- **Specular Refractive Index Material:** The white Specular Refractive Index material input accepts a 2D image or a 3D material using the RGB channels as the refraction texture.
- **Bump Map Material:** The white Bump Map material input accepts only a 3D material. Typically, you connect the texture into a Bump Map node, and then connect the Bump Map node to this input. This input uses the RGB information as texture-space normals.

Each of these inputs multiplies the pixels in the texture map by the equivalently named parameters in the node itself. This provides an effective method for scaling parts of the material.

When nodes have as many inputs as this one does, it is often difficult to make connections with any precision. Hold down the Option (macOS) or Alt (Windows) key while dragging the output from another node over the node tile, and keep holding Option or Alt when releasing the left mouse button. A small drop-down menu listing all the inputs provided by the node appears. Click on the desired input to complete the connection.
Basic Node Setup

The output of a Cook Torrance node output is connected to the material input on a 3D scene or 3D geometry node to which you want the shader applied. The Cook Torrance inputs can use images as the diffuse color material (yellow) and specular color material (green). This can result in a smooth, shiny material.

A Cook Torrance shader with diffuse and specular color materials connected

Inspector

Controls Tab

The Controls tab contains parameters for adjusting the main color, highlight, and lighting properties of the Cook Torrance shader node.

Diffuse

Diffuse describes the base surface characteristics without any additional effects like reflections or specular highlights. Besides defining the base color of an object, the diffuse color also defines the transparency of the object. The Alpha in a diffuse texture map can be used to make portions of the surface transparent.
Diffuse Color
A material’s Diffuse Color describes the base color presented by the material when it is lit indirectly or by ambient light. If a diffuse texture map is provided, then the color value provided here is multiplied by the color values in the texture.

Alpha
This slider sets the material’s Alpha channel value. This affects diffuse and specular colors equally, and affects the Alpha value of the material in the rendered output. If a diffuse texture map is provided, then the Alpha value set here is multiplied by the Alpha values in the texture map.

Opacity
Reducing the material’s Opacity decreases the color and Alpha values of the specular and diffuse colors equally, making the material transparent.

Specular
The parameters in the Specular section describe the look of the specular highlight of the surface. These values are evaluated in a different way for each illumination model.

Specular Color
Specular Color determines the color of light that reflects from a shiny surface. The more specular a material is, the glossier it appears. Surfaces like plastics and glass tend to have white specular highlights, whereas metallic surfaces like gold have specular highlights that inherit their color from the material color. If a specular texture map is provided, then the value provided here is multiplied by the color values from the texture.

Specular Intensity
Specular Intensity controls how strong the specular highlight is. If the specular intensity texture is provided, then this value is multiplied by the Alpha value of the texture.

Roughness
The Roughness of the specular highlight describes diffusion of the specular highlight over the surface. The greater the value, the wider the falloff, and the more brushed and metallic the surface appears. If the roughness texture map is provided, then this value is multiplied by the Alpha value from the texture.

Do Fresnel
Selecting this checkbox adds Fresnel calculations to the material’s illumination model. This provides more realistic-looking metal surfaces by taking into account the refractiveness of the material.

Refractive Index
This slider appears when the Do Fresnel checkbox is selected. The Refractive Index applies only to the calculations for the highlight; it does not perform actual refraction of light through transparent surfaces. If the refractive index texture map is provided, then this value is multiplied by the Alpha value of the input.

Transmittance
Transmittance controls the way light passes through a material. For example, a solid blue sphere casts a black shadow, but one made of translucent blue plastic would cast a much lower density blue shadow.

There is a separate Opacity option. Opacity determines how transparent the actual surface is when it is rendered. Fusion allows adjusting both opacity and transmittance separately. At first, this might be a bit counterintuitive to those who are unfamiliar with 3D software. It is possible to have a surface that is fully opaque but transmits 100% of the light arriving upon it, effectively making it a luminous/ emissive surface.
**Attenuation**

Attenuation determines how much color is passed through the object. For an object to have transmissive shadows, set the attenuation to (1, 1, 1), which means 100% of green, blue, and red light passes through the object. Setting this color to RGB (1, 0, 0) means that the material transmits 100% of the red arriving at the surface but none of the green or blue light. This can be used to create “stained glass”-styled shadows.

**Alpha Detail**

When the Alpha Detail slider is set to 0, the Alpha channel of the object is ignored and the entire object casts a shadow. If it is set to 1, the Alpha channel determines what portions of the object cast a shadow.

**Color Detail**

The Color Detail slider modulates light passing through the surface by the diffuse color + texture colors. Use this to throw a shadow that contains color details of the texture applied to the object. Increasing the slider from 0 to 1 brings in more diffuse color + texture color into the shadow. Note that the Alpha and opacity of the object are ignored when transmitting color, allowing an object with a solid Alpha to still transmit its color to the shadow.

**Saturation**

The Saturation slider controls the saturation of the color component transmitted to the shadow. Setting this to 0.0 results in monochrome shadows.

**Receives Lighting/Shadows**

These checkboxes control whether the material is affected by lighting and shadows in the scene. If turned off, the object is always fully lit and/or unshadowed.

**Two-Sided Lighting**

This effectively makes the surface two sided by adding a second set of normals facing the opposite direction on the backside of the surface. This is normally off to increase rendering speed, but it can be turned on for 2D surfaces or for objects that are not fully enclosed, to allow the reverse or interior surfaces to be visible as well.

Normally, in a 3D application, only the front face of a surface is visible and the back face is culled, so that if a camera were to revolve around a plane in a 3D application, when it reached the backside, the plane would become invisible. Making a plane two sided in a 3D application is equivalent to adding another plane on top of the first but rotated by 180 degrees so the normals are facing the opposite direction on the backside. Thus, when you revolve around the back, you see the second image plane, which has its normals facing the opposite way.

**NOTE:** This can become rather confusing once you make the surface transparent, as the same rules still apply and produce a result that is counterintuitive. If you view from the frontside a transparent two-sided surface illuminated from the backside, it looks unlit.

**Material ID**

This slider sets the numeric identifier assigned to this material. This value is rendered into the MatID auxiliary channel if the corresponding option is enabled in the renderer.

**Common Controls**

**Settings Tab**

The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
Material Merge 3D [3MM]

The Material Merge node

Material Merge Node Introduction

The Material Merge node can be used to combine two separate materials together. This node can be used to composite Material nodes, combining multiple illumination materials (Blinn, Cook Torrance) with texture nodes (Bump Map, Reflection) to create complex shader networks.

The node also provides a mechanism for assigning a new material identifier to the combined material.

Inputs

The Material Merge node includes two inputs for the two materials you want to combine.

- **Background Material**: The orange Background material input accepts a 2D image or a 3D material to be used as the background material.

- **Foreground Material**: The green Foreground material input accepts a 2D image or a 3D material to be used as the foreground material. A 2D image is treated as a diffuse texture map in the basic shading model.

Basic Node Setup

The output of a Material Merge node is connected to the material input on a 3D scene or 3D geometry node. The Material Merge node below is taking in a background base layer from the Blinn shader and combining it with a more textured bump map layer.

A Material Merge node combining a Blinn-based shader (teal underlay) and a Ward-based shader (orange underlay)
Inspector

Controls Tab

The Controls tab includes a single slider for blending the two materials together.

Blend

The Blend behavior of the Material Merge is similar to the Dissolve (DX) node for images. The two materials/textures are mixed using the value of the slider to determine the percentage each input contributes. While the background and foreground inputs can be a 2D image instead of a material, the output of this node is always a material.

Unlike the 2D Dissolve node, both foreground and background inputs are required.

Material ID

This slider sets the numeric identifier assigned to the resulting material. This value is rendered into the MatID auxiliary channel if the corresponding option is enabled in the renderer.

Common Controls

Settings Tab

The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Phong [3PH]

Phong Node Introduction

The Phong node is a basic illumination material that can be applied to geometry in the 3D scene. It describes how the object responds to light and provides multiple texture map inputs to allow fine control over the diffuse, specular, and bump map components of the material.

While producing a highlight similar to that produced by the Blinn model, it is more commonly used for shiny/polished plastic surfaces.
Inputs

There are five inputs on the Phong node that accept 2D images or 3D materials. These inputs control the overall color and image used for the 3D object as well as controlling the color and texture used in the specular highlight. Each of these inputs multiplies the pixels in the texture map by the equivalently named parameters in the node itself. This provides an effective method for scaling parts of the material.

- **Diffuse Material**: The orange Diffuse material input accepts a 2D image or a 3D material to be used as a main color and texture of the object.

- **Specular Color Material**: The green Specular Color material input accepts a 2D image or a 3D material to be used as a highlight color and texture of the object.

- **Specular Intensity Material**: The magenta Specular Intensity material input accepts a 2D image or a 3D material to be used as an intensity map for the material’s highlights. When the input is a 2D image, the Alpha channel is used to create the map, while the color channels are discarded.

- **Specular Exponent Material**: The teal Specular Exponent material input accepts a 2D image or a 3D material to be used as a falloff map for the material’s specular highlights. When the input is a 2D image, the Alpha channel is used to create the map, while the color channels are discarded.

- **Bump Map Material**: The white Bump Map texture input accepts only a 3D material. Typically, you connect the texture into a Bump Map node, and then connect the Bump Map node to this input. This input uses the RGB information as texture-space normals.

When nodes have as many inputs as this one does, it is often difficult to make connections with any precision. Hold down the Option or Alt key while dragging the output from another node over the node tile, and keep holding Option or Alt when releasing the left mouse button. A small drop-down menu listing all the inputs provided by the node appears. Click on the desired input to complete the connection.

Basic Node Setup

The output of a Phong node is connected to the material input on a 3D scene or 3D geometry node. The Phong node below is taking in a base Color Diffuse input from the Fast Noise node and a bump map texture also generated from a Fast Noise node.
Inspector

Controls Tab
The Controls tab contains parameters for adjusting the main color, highlight, and lighting properties of the Phong shader node.

Diffuse
Diffuse describes the base surface characteristics without any additional effects like reflections or specular highlights. Besides defining the base color of an object, the diffuse color also defines the transparency of the object.

The Alpha in a diffuse texture map can be used to make portions of the surface transparent.

Diffuse Color
A material's Diffuse Color describes the base color presented by the material when it is lit indirectly or by ambient light. If a diffuse texture map is provided, then the color value provided here is multiplied by the color values in the texture.

Alpha
This slider sets the material's Alpha channel value. This affects diffuse and specular colors equally and affects the Alpha value of the material in the rendered output. If a diffuse texture map is provided, then the Alpha value set here is multiplied by the Alpha values in the texture map.

Opacity
Reducing the material's Opacity decreases the color and Alpha values of the specular and diffuse colors equally, making the material transparent.

Specular
The parameters in the Specular section describe the look of the specular highlight of the surface. These values are evaluated in a different way for each illumination model.
Specular Color
Specular Color determines the color of light that reflects from a shiny surface. The more specular a material is, the glossier it appears. Surfaces like plastics and glass tend to have white specular highlights, whereas metallic surfaces like gold have specular highlights that inherit their color from the material color. If a specular texture map is provided, then the value provided here is multiplied by the color values from the texture.

Specular Intensity
Specular Intensity controls how strong the specular highlight is. If the specular intensity texture is provided, then this value is multiplied by the Alpha value of the texture.

Specular Exponent
Specular Exponent controls the falloff of the specular highlight. The greater the value, the sharper the falloff, and the smoother and glossier the material appears. If the specular exponent texture is provided, then this value is multiplied by the Alpha value of the texture map.

Transmittance
Transmittance controls the way light passes through a material. For example, a solid blue sphere casts a black shadow, but one made of translucent blue plastic would cast a much lower density blue shadow.

There is a separate Opacity option. Opacity determines how transparent the actual surface is when it is rendered. Fusion allows adjusting both opacity and transmittance separately. At first, this might be a bit counterintuitive to those who are unfamiliar with 3D software. It is possible to have a surface that is fully opaque but transmits 100% of the light arriving upon it, effectively making it a luminous/emissive surface.

Attenuation
Attenuation determines how much color is passed through the object. For an object to have transmissive shadows, set the attenuation to (1, 1, 1), which means 100% of green, blue, and red light passes through the object. Setting this color to RGB (1, 0, 0) means that the material transmits 100% of the red arriving at the surface but none of the green or blue light. This can be used to create “stained glass”-styled shadows.

Alpha Detail
When the Alpha Detail slider is set to 0, the Alpha channel of the object is ignored and the entire object casts a shadow. If it is set to 1, the Alpha channel determines what portions of the object cast a shadow.

Color Detail
The Color Detail slider modulates light passing through the surface by the diffuse color + texture colors. Use this to throw a shadow that contains color details of the texture applied to the object. Increasing the slider from 0 to 1 brings in more diffuse color + texture color into the shadow. Note that the Alpha and opacity of the object are ignored when transmitting color, allowing an object with a solid Alpha to still transmit its color to the shadow.

Saturation
The Saturation slider controls the saturation of the color component transmitted to the shadow. Setting this to 0.0 results in monochrome shadows.

Receives Lighting/Shadows
These checkboxes control whether the material is affected by lighting and shadows in the scene. If turned off, the object is always fully lit and/or unshadowed.
Two-Sided Lighting
This effectively makes the surface two sided by adding a second set of normals facing the opposite
direction on the backside of the surface. This is normally off to increase rendering speed, but it can be
turned on for 2D surfaces or for objects that are not fully enclosed, to allow the reverse or interior
surfaces to be visible as well.

Normally, in a 3D application, only the front face of a surface is visible and the back face is culled, so
that if a camera were to revolve around a plane in a 3D application, when it reached the backside, the
plane would become invisible. Making a plane two sided in a 3D application is equivalent to adding
another plane on top of the first but rotated by 180 degrees so the normals are facing the opposite
direction on the backside. Thus, when you revolve around the back, you see the second image plane,
which has its normals facing the opposite way.

Fusion does exactly the same thing as 3D applications when you make a surface two sided. The
confusion about what two-sided lighting does arises because Fusion does not cull back-facing
polygons by default. If you revolve around a one-sided plane in Fusion, you still see it from the
backside (but you are seeing the frontside duplicated through to the backside as if it were transparent).
Making the plane two sided effectively adds a second set of normals to the backside of the plane.

NOTE: This can become rather confusing once you make the surface transparent, as the
same rules still apply and produce a result that is counterintuitive. If you view from the
frontside a transparent two-sided surface illuminated from the backside, it looks unlit.

Material ID
This slider sets the numeric identifier assigned to this material. This value is rendered into the MatID
auxiliary channel if the corresponding option is enabled in the renderer.

Common Controls
Settings Tab
The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are
described in detail at the end of this chapter in “The Common Controls” section.

Reflect [3RR]

Reflect Node Introduction
The Reflect node is used to add environment map reflections and refractions to materials.
Control is offered over the face on and glancing strength, falloff, per channel refraction indexes, and
tinting. Several texture map inputs can modify the behavior of each parameter.

Environment mapping is an approximation that assumes an object’s environment is infinitely distant
from the object. It’s best to picture this as a cube or sphere with the object at the center. Specifically,
this infinite distance assumption means that objects cannot interact with themselves (e.g., the
reflections on the handle of a teapot do not show the body of the teapot but rather the infinite
environment map). It also means that if you use the same cube map on multiple objects in the scene, those objects do not inter-reflect each other (e.g., two neighboring objects would not reflect each other). If you want objects to reflect each other, you need to render a cube map for each object.

For more information, see Chapter 25, “3D Compositing Basics” in the Fusion Reference Manual or Chapter 86 in the DaVinci Resolve Reference Manual.

Inputs
There are five inputs on the Reflect node that accept 2D images or 3D materials. These inputs control the overall color and image used for the 3D object as well as controlling the color and texture used in the reflective highlights.

- **Background Material**: The orange Background material input accepts a 2D image or a 3D material. If a 2D image is provided, the node treats it as a diffuse texture map applied to a basic material.

- **Reflection Color Material**: The white Reflection Color material input accepts a 2D image or a 3D material. The RGB channels are used as the reflection texture, and the Alpha is ignored.

- **Reflection Intensity Material**: The white Reflection Intensity material input accepts a 2D image or a 3D material. The Alpha channel of the texture is multiplied by the intensity of the reflection.

- **Refraction Tint Material**: The white Refraction Tint material input accepts a 2D image or a 3D material. The RGB channels are used as the refraction texture.

- **Bump Map Texture**: The white Bump Map texture input accepts only a 3D material. Typically, you connect the texture into a Bump Map node, and then connect the Bump Map node to this input. This input uses the RGB information as texture-space normals.

When nodes have as many inputs and some using the same color as this one does, it is often difficult to make connections with any precision. Hold down the Option or Alt key while dragging the output from another node over the node tile, and keep holding Option or Alt when releasing the left mouse button. A small drop-down menu listing all the inputs provided by the node appears. Click on the desired input to complete the connection.

Basic Node Setup
The Reflection node can be the main shader for an object as it is in the example below, or it can be used to feed the diffuse material input of a Ward, Blinn, Phong, or other material node. Usually, a Sphere Map node is used as the source of the Reflect node’s reflection color input.

A Reflect node used to create a highly reflective surface of a Shape 3D node
Inspector

Reflect controls

Controls Tab
The Controls tab contains parameters for adjusting the reflective strength based on the orientation of the object, as well as the tint color of the Reflect shader node.

Reflection

Reflection Strength Variability
This multi-button control can be set to Constant or By Angle for varying the reflection intensity, corresponding to the relative surface orientation to the viewer. The following three controls are visible only when this control is set to By Angle.

Glancing Strength
[By Angle] Glancing Strength controls the intensity of the reflection for those areas of the geometry where the reflection faces away from the camera.

Face On Strength
[By Angle] Face On Strength controls the intensity of the reflection for those parts of the geometry that reflect directly back to the camera.

Falloff
[By Angle] Falloff controls the sharpness of the transition between the Glancing and Face On Strength regions. It can be considered similar to applying gamma correction to a gradient between the Face On and Glancing values.

Constant Strength
[Constant Angle] This control is visible only when the reflection strength variability is set to Constant. In this case, the intensity of the reflection is constant despite the incidence angle of the reflection.
Refraction
If the incoming background material has a lower opacity than 1, then it is possible to use an environment map as refraction texture, and it is possible to simulate refraction effects in transparent objects.

Separate RGB Refraction Indices
When this checkbox is enabled, the Refraction Index slider is hidden, and three sliders for adjusting the refraction index of the Red, Green, and Blue channels appear in its place. This allows simulation of the spectral refraction effects commonly seen in thick imperfect glass, for example.

Refraction Index
This slider controls how strongly the environment map is deformed when viewed through a surface. The overall deformation is based on the incidence angle. Since this is an approximation and not a simulation, the results are not intended to model real refractions accurately.

Refraction Tint
The refraction texture is multiplied by the tint color for simulating color-filtered refractions. It can be used to simulate the type of coloring found in tinted glass, as seen in many brands of beer bottles, for example.

Common Controls
Settings Tab
The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Stereo Mix [3SMM]

Stereo Mix Node Overview
This node is used to swap the left and right material inputs. It is often used to output to the left and right eye of the 3D Render.

Inputs
This node has two inputs that are both required for this node to work. Both inputs accept either a 2D image or a 3D material.

- **LeftMaterial**: The orange left material input accepts a 2D image or a 3D material to be used as the material for the left eye rendering. If a 2D image is used, it is converted to a diffuse texture map using the basic material type.

- **RightMaterial**: The green right material input accepts a 2D image or a 3D material to be used as the material for the right eye rendering. If a 2D image is used, it is converted to a diffuse texture map using the basic material type.

While the inputs can be either 2D images or 3D materials, the output is always a material.
Basic Node Setup
The Stereo Mix node can be used with either stereo images or materials. The example below shows two images combined in the Stereo Mix node causing the output to be a stereo anaglyph material.

A Stereo Mix node used to combine left and right images into a single stereo material

Inspector

Controls Tab
The Controls tab contains a single switch that swaps the left and right material inputs.

Swap
This option swaps both inputs of the node.

Material ID
This slider sets the numeric identifier assigned to this material. This value is rendered into the MatID auxiliary channel if the corresponding option is enabled in the renderer.

Common Controls

Settings Tab
The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
Ward Node Introduction

The Ward node is a basic illumination material that can be applied to geometry in the 3D scene. It describes how the object responds to light and provides multiple texture map inputs to allow fine control over the diffuse, specular, and bump map components of the material.

Specifically, the Ward node is ideal for simulating brushed metal surfaces, as the highlight can be elongated along the U or V directions of the mapping coordinates. This is known as an anisotropic highlight.

The Ward node outputs a 3D Material that can be connected to the material inputs on any 3D geometry node.

Inputs

There are six inputs on the Ward node that accept 2D images or 3D materials. These inputs control the overall color and image used for the 3D object as well as controlling the color and texture used in the specular highlight. Each of these inputs multiplies the pixels in the texture map by the equivalently named parameters in the node itself. This provides an effective method for scaling parts of the material.

- **Diffuse Material**: The orange Diffuse material input accepts a 2D image or a 3D material to be used as a main color and texture of the object.

- **Specular Color Material**: The green Specular Color material input accepts a 2D image or a 3D material to be used as a highlight color and texture of the object.

- **Specular Intensity Material**: The magenta Specular Intensity material input accepts a 2D image or a 3D material to be used as an intensity map for the material’s highlights. When the input is a 2D image, the Alpha channel is used to create the map, while the color channels are discarded.

- **Spread U Material**: The white Spread U material input accepts a 2D image or a 3D material. The value of the Spread U option in the node’s controls is multiplied against the pixel values in the material’s Alpha channel.

- **Spread V Material**: The white Spread V material input accepts a 2D image or a 3D material. The value of the Spread V option in the node’s controls is multiplied against the pixel values in the material’s Alpha channel.

- **Bump Map Material**: The white Bump Map material input accepts only a 3D material. Typically, you connect the texture into a Bump Map node, and then connect the Bump Map node to this input. This input uses the RGB information as texture-space normals.

When nodes have as many inputs and some using the same color as this one does, it is often difficult to make connections with any precision. Hold down the Option or Alt key while dragging the output from another node over the node tile, and keep holding Option or Alt when releasing the left mouse button. A small drop-down menu listing all the inputs provided by the node appears. Click on the desired input to complete the connection.
Basic Node Setup

The Ward node is used to make a shiny glass surface and replace the 3D text material in the example below. A diffuse color material comes from Reflect node, and the specular color is altered by a gradient color Fast Noise node.

![Ward node setup diagram]

A Ward node used with a diffuse connection and specular color connection

Inspector

Ward controls

Controls Tab

The Controls tab contains parameters for adjusting the main color, highlight, and lighting properties of the Ward shader node.

Diffuse

Diffuse describes the base surface characteristics without any additional effects like reflections or specular highlights. Besides defining the base color of an object, the diffuse color also defines the transparency of the object. The Alpha in a diffuse texture map can be used to make portions of the surface transparent.
Diffuse Color
A material’s Diffuse Color describes the base color presented by the material when it is lit indirectly or by ambient light. If a diffuse texture map is provided, then the color value provided here is multiplied by the color values in the texture.

Alpha
This slider sets the material’s Alpha channel value. This affects diffuse and specular colors equally and affects the Alpha value of the material in the rendered output. If a diffuse texture map is provided, then the Alpha value set here is multiplied by the Alpha values in the texture map.

Opacity
Reducing the material’s Opacity decreases the color and Alpha values of the specular and diffuse colors equally, making the material transparent.

Specular
The parameters in the Specular section describe the look of the specular highlight of the surface. These values are evaluated in a different way for each illumination model.

Specular Color
Specular Color determines the color of light that reflects from a shiny surface. The more specular a material is, the glossier it appears. Surfaces like plastics and glass tend to have white specular highlights, whereas metallic surfaces like gold have specular highlights that inherit their color from the material color. If a specular texture map is provided, then the value provided here is multiplied by the color values from the texture.

Specular Intensity
Specular Intensity controls how strong the specular highlight is. If the specular intensity texture is provided, then this value is multiplied by the Alpha value of the texture.

Spread U
Spread U controls the falloff of the specular highlight along the U-axis in the UV map of the object. The smaller the value, the sharper the falloff, and the smoother and glossier the material appears in this direction. If the Spread U texture is provided, then this value is multiplied by the Alpha value of the texture.

Spread V
Spread V controls the falloff of the specular highlight along the V-axis in the UV map of the object. The smaller the value, the sharper the falloff, and the smoother and glossier the material appear in this direction. If the Spread V texture is provided, then this value is multiplied by the Alpha value of the texture.

Transmittance
Transmittance controls the way light passes through a material. For example, a solid blue sphere casts a black shadow, but one made of translucent blue plastic would cast a much lower density blue shadow.

There is a separate Opacity option. Opacity determines how transparent the actual surface is when it is rendered. Fusion allows adjusting both opacity and transmittance separately. At first, this might be a bit counterintuitive to those who are unfamiliar with 3D software. It is possible to have a surface that is fully opaque but transmits 100% of the light arriving upon it, effectively making it a luminous/ emissive surface.

Attenuation
Attenuation determines how much color is passed through the object. For an object to have transmissive shadows, set the attenuation to (1, 1, 1), which means 100% of green, blue, and red light passes through the object. Setting this color to RGB (1, 0, 0) means that the material transmits 100% of
the red arriving at the surface but none of the green or blue light. This can be used to create “stained
glass”-styled shadows.

**Alpha Detail**
When the Alpha Detail slider is set to 0, the Alpha channel of the object is ignored, and the entire
object casts a shadow. If it is set to 1, the Alpha channel determines what portions of the object
cast a shadow.

**Color Detail**
The Color Detail slider modulates light passing through the surface by the diffuse color + texture
colors. Use this to throw a shadow that contains color details of the texture applied to the object.
Increasing the slider from 0 to 1 brings in more diffuse color + texture color into the shadow. Note that
the Alpha and opacity of the object are ignored when transmitting color, allowing an object with a solid
Alpha to still transmit its color to the shadow.

**Saturation**
The Saturation slider controls the saturation of the color component transmitted to the shadow. Setting
this to 0.0 results in monochrome shadows.

**Receives Lighting/Shadows**
These checkboxes control whether the material is affected by lighting and shadows in the scene. If
turned off, the object is always fully lit and/or unshadowed.

**Two-Sided Lighting**
This effectively makes the surface two sided by adding a second set of normals facing the opposite
direction on the backside of the surface. This is normally off to increase rendering speed, but it can be
turned on for 2D surfaces or for objects that are not fully enclosed, to allow the reverse or interior
surfaces to be visible as well.

Normally, in a 3D application, only the front face of a surface is visible and the back face is culled, so
that if a camera were to revolve around a plane in a 3D application, when it reached the backside, the
plane would become invisible. Making a plane two sided in a 3D application is equivalent to adding
another plane on top of the first but rotated by 180 degrees so the normals are facing the opposite
direction on the backside. Thus, when you revolve around the back, you see the second image plane,
which has its normals facing the opposite way.

Fusion does exactly the same thing as 3D applications when you make a surface two sided. The
confusion about what two-sided lighting does arises because Fusion does not cull back-facing
polygons by default. If you revolve around a one-sided plane in Fusion you still see it from the
backside (but you are seeing the frontside duplicated through to the backside as if it were transparent).
Making the plane two sided effectively adds a second set of normals to the backside of the plane.

**NOTE:** This can become rather confusing once you make the surface transparent, as the
same rules still apply and produce a result that is counterintuitive. If you view from the
frontside a transparent two-sided surface illuminated from the backside, it looks unlit.

**Material ID**
This slider sets the numeric identifier assigned to this material. This value is rendered into the MatID
auxiliary channel if the corresponding option is enabled in the renderer.

**Common Controls**

**Settings Tab**
The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are
described in detail in the following “The Common Controls” section.
The Common Controls

Nodes that handle 3D geometry share a number of identical controls in the Inspector. This section describes controls that are common among 3D Material nodes.

Settings Tab

Common Settings 3D controls

Common Settings tab can be found on most tools in Fusion. The following controls are specific settings for 3D nodes:

**Hide Incoming Connections**

Enabling this checkbox can hide connection lines from incoming nodes, making a node tree appear cleaner and easier to read. When enabled, fields for each input on a node are displayed. Dragging a connected node from the node tree into the field hide that incoming connection line as long as the node is not selected in the node tree. When the node is selected in the node tree, the line reappears.

**Comment Tab**

The Comment tab contains a single text control that is used to add comments and notes to the tool. When a note is added to a tool, a small red dot icon appears next to the setting’s tab icon, and a text bubble appears on the node. To see the note in the Node Editor, hold the mouse pointer over the node for a moment. The contents of the Comments tab can be animated over time, if required.

**Scripting Tab**

The Scripting tab is present on every tool in Fusion. It contains several edit boxes used to add scripts that process when the tool is rendering. For more details on the contents of this tab, please consult the scripting documentation.
This chapter details the 3D Texture nodes available when creating 3D composites in Fusion. The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

- Bump Map [3Bu] 1769
- Catcher [3CA] 1772
- CubeMap [3CU] 1774
- Falloff [3FA] 1777
- Fast Noise Texture [3FN] 1779
- Gradient 3D [3GD] 1782
- Sphere Map [3SPM] 1785
- Texture 2D [3Tx] 1787
- Texture Transform [3TT] 1789
- The Common Controls 1791
Bump Map [3Bu]

Bump Map Node Overview
The Bump Map node is used to convert a grayscale (height map) image into a bump map and takes an input directly from a bump map created by the Create Bump Map node. The node outputs a material.

Inputs
The Bump Map node includes a single orange input for connecting a 2D image you want to use as the bump map texture, or it can accept the output of the Create Bump Map node.

- **Image Input**: The orange Image input is used to connect a 2D RGBA image for the bump calculation or an existing bump map from the Create Bump map node.

Basic Node Setup
The Bump Map node is connected to the Bump Map material input on any one of the material shader nodes. Below, the example uses a Fast Noise node to generate an image that connects to the Bump Map node. The output of the Bump Map node connects to the Bump Map material input on a Ward node.

A Bump Map is connected to the Bump Map material input on a material node.
Controls Tab
The Controls tab contains all parameters for modifying the input source and the appearance of the bump map.

Source Image Type
Toggle between Height Map, which creates a bump map similar to the Create Bump Map node, and Bump Map, which expects a bump map created by the Create Bump Map node.

Filter Size
A custom filter generates the bump information. The drop-down menu sets the filter size.

Height Channel
Sets the channel from which to extract the grayscale information.

Clamp Z Normal
Clips the lower values of the blue channel in the resulting bump texture.

Height Scale
Changes the contrast of the resulting values in the bump map. Increasing this value yields a more visible bump map.

Texture Depth
Optionally converts the resulting bump map texture into the desired bit depth.

Wrap Mode
Wraps the image at the borders, so the filter produces correct result when using seamless tile textures.
Common Controls

Settings Tab
The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Notes on Bump Maps
There is some confusion of terminology with bump mapping, depending on where you get your information. Here are Fusion conventions:

**Height Map**
A grayscale image containing a height value per pixel

**Bump Map**
An image containing normals stored in the RGB channels used for modifying the existing normals (usually given in tangent space)

**Normals Map**
An image containing normals stored in the RGB channels used for replacing the existing normals (usually given in tangent or object space)
Catcher Node Overview

The Catcher material is used to "catch" texture-mode projections cast from Projector 3D and Camera 3D nodes. The intercepted projections are converted into a texture map and applied by the Catcher material to the geometry to which it is connected.

To understand the Catcher node, it helps to understand the difference between light-based projections and texture-based projections. Choosing Light from the projection mode menu on the Projector 3D or Camera 3D nodes simply adds the values of the RGB channels in the projected image to the diffuse texture of any geometry that lies within the projection cone. This makes it impossible to clip away geometry based on the Alpha channel of an image when using light mode projections.

Imagine a scenario where you want to project an image of a building onto an image plane as part of a set extension shot. You first rotoscope the image to mask out the windows. This makes it possible to see the geometry of the rooms behind the wall in the final composite. When this image is projected as light, the Alpha channel is ignored, so the masked windows remain opaque.

By connecting the Catcher to the diffuse texture map of the material applied to the image plane, and then switching the projection mode menu in the Projector 3D or Camera 3D node from Light or Ambient Light mode to Texture mode, the projected image is applied as a texture map. When using this technique for the example above, the windows would become transparent, and it would be possible to see the geometry behind the window.

The main advantages of this approach over light projection are that the Catcher can be used to project Alpha onto an object, and it doesn’t require lighting to be enabled. Another advantage is that the Catcher is not restricted to the diffuse input of a material, making it possible to project specular intensity maps, or even reflection and refraction maps.

**NOTE:** The Catcher material requires a Projector 3D or Camera 3D node in the scene, set to project an image in Texture mode on the object to which the Catcher is connected. Without a projection, or if the projection is not set to Texture mode, the Catcher simply makes the object transparent and invisible.

**Inputs**

The Catcher node has no inputs. The output of the node is connected to the the diffuse color material input of the Blinn, Cook Torrance, or other material node applied to the 3D geometry.
**Basic Node Setup**

The output of a Catcher node should be connected to the material input of your 3D geometry node. A camera is set up as a proctor with an image connected to the camera’s image input. When the camera is set to texture projection mode, the Catcher node is used to determine which geometry receives the texture.

![Catcher node setup](image)

A Catcher node output is connected to the input of the geometry node that receives the texture projection.

**Inspector**

![Inspector panel](image)

**Controls Tab**

The Options in the Controls tab determine how the Catcher handles the accumulation of multiple projections.

**Enable**

Use this checkbox to enable or disable the node. This is not the same as the red switch in the upper-left corner of the Inspector. The red switch disables the tool altogether and passes the image on without any modification. The Enable checkbox is limited to the effect part of the tool. Other parts, like scripts in the Settings tab, still process as normal.

**Color Mode**

The Color mode menu is used to control how the Catcher combines the light from multiple projectors. It has no effect on the results when only one projector is in the scene. This control is designed to work with the software renderer in the Renderer 3D node and has no effect when using the OpenGL renderer.
Alpha Mode
The Alpha mode is used to control how the Catcher combines the Alpha channels from multiple projectors. It has no effect on the results when only one projector is in the scene. This control is designed to work with the software renderer in the Renderer 3D node and has no effect when using the OpenGL renderer.

Threshold
The Threshold can be used to exclude certain low values from the accumulation calculation. For example, when using the Median Accumulation mode, a threshold of 0.01 would exclude any pixel with a value of less than 0.01 from the median calculation.

Restrict by Projector ID
When active, the Catcher only receives light from projectors with a matching ID. Projectors with a different ID are ignored.

Material ID
This slider sets the numeric identifier assigned to this material. This value is rendered into the MatID auxiliary channel if the corresponding option is enabled in the Renderer 3D node.

Common Controls
Settings Tab
The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

CubeMap [3CU]

The Cube Map node

Cube Map Node Overview
The Cube Map node creates texture maps using separate images for each face of the cube. It can also extract the individual faces of the cube from a single image containing an unfolded cube in the Vertical or Horizontal Cross layouts.

A cube map is produced by mounting six cameras at 90 degrees angle of views to point up, down, left, right, front, and back.

The node provides options to set the reference coordinate system and rotation for the resulting texture map. The Cube Map node is typically used to produce environment maps for distant areas (such as skies or horizons) or reflection and refraction maps.
Sample cube map

**Inputs**

The Inputs on this node change based on the settings of the Layout menu in the Inspector. The single input uses a 2D image for the entire cube, while six inputs can handle a different 2D image for each side of a cube.

- **CrossImage**: The orange Cross Image input is visible by default or when the Layout menu in the Inspector is set to either Vertical Cross or Horizontal Cross. The input accepts a 2D image.

- **CubeMap.[DIRECTION]**: These six multi-colored inputs are visible only when the Layout menu in the Inspector is set to Separate Images. Each input accepts an image aligned to match the left, right, top, bottom, front, and back faces.

**Basic Node Setup**

The Cube Map node uses a vertical or horizontal cross image represented by MediaIn2 node connected into the orange cross image input. The Cube Map node is used similarly to the Sphere Map node. It creates an environment that surrounds the geometry connected to a Shader node.

A Cube Map node receives a cross image input, creating an environment for the Shape 3D
Inspector

Controls Tab

Layout
The Layout menu determines the type and number of inputs for the cube map texture.
Valid options are:

– **Separate Images**: This option exposes six inputs on the node, one for each face of the cube. If the separate images are not square or not of the same size, they are rescaled into the largest 1:1 image that can contain all of them.

– **Vertical Cross**: This option exposes a single input on the node. The image should be an unwrapped texture of a cube containing all the faces organized into a Vertical Cross formation, where the height is larger than the width. If the image aspect of the cross image is not 3:4, the CubeMap node crops it down so it matches the applicable aspect ratio.

– **Horizontal Cross**: This option exposes a single input on the node. The image should be an unwrapped texture of a cube containing all the faces organized into a Horizontal Cross formation, where the width is larger than the height. If the image aspect of the cross image is not 4:3, the CubeMap node crops it down so that matches the applicable aspect ratio.

Coordinate System
The coordinate system menu sets the position values used when converting the image into a texture.

– **Model**: This option orients the texture along the object local coordinate system.

– **World**: This option orients the resulting texture using the global or world coordinate system.

– **Eye**: This option aligns the texture map to the coordinate system of the camera or viewer.

Rotation
The rotation controls are divided into buttons that select the order of rotation along each axis of the texture. For example, XYZ would apply the rotation to the X axis first, followed by the Y axis, and finally the Z axis. The other half of the rotation controls are dials that rotate the texture around its pivot point.
Warn About Bad Dimensions
Selecting this checkbox displays a warning message on the console if the dimensions of the image provided did not meet the requirements of the selected orientation mode.

Material ID
This slider sets the numeric identifier assigned to this material. This value is rendered into the MatID auxiliary channel if the corresponding option is enabled in the renderer.

Common Controls
Settings Tab
The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Falloff [3FA]

The Falloff node

Falloff Node Overview
The Falloff node blends two materials or textures together based on the incidence angle between the object to which the material is applied and the camera. This is useful when you wish to use one material for portions of the geometry that would reflect light directly back to the camera and a different material for parts that reflect light back into the scene.
**Inputs**

The two Inputs on the Falloff node are used to connect two images or materials. One is used to reflect back at the camera, while the other reflects away from the camera and into the scene.

- **Face On Material:** The orange Face On material input accepts a 2D image or a 3D material. If a 2D image is provided, it is turned into a diffuse texture map using the basic material shader. This input is used for the material that is reflecting directly back to the camera.

- **Glancing Material:** The green Glancing material input accepts a 2D image or a 3D material. If a 2D image is provided, it is turned into a diffuse texture map using the basic material shader. This input is used for the material that is reflecting away from the camera and into the scene.

While the inputs for this node can be images, the output is always a material.

**Basic Node Setup**

The Falloff node below is used to control the strength of the Blinn material and the Reflect material. You connect the Face On input of the Falloff node to the material you want shown for the sides of the object that face the camera and connect the Glance input to the material you want shown for the sides not directly facing the camera.

![Falloff node setup](image)

The Falloff node uses one input for the material facing the camera and one for the material not directly facing the camera.

**Inspector**

![Falloff controls](image)
Controls Tab
The parameters in the Controls tabs modify the tint and opacity of the Face On material and the Glancing material. A Falloff slider controls the blending between the two.

Color Variation
- **Two Tone**: Two regular Color controls define the colors for Glancing and Face On.
- **Gradient**: A Gradient control defines the colors for Glancing and Face On. This can be used for a multitude of effects, like creating Toon Shaders, for example.

Face On Color
The Face On Color defines the color of surface parts facing the camera. If the Face On texture map is provided, then the color value provided here is multiplied by the color values in the texture.

Reducing the material's opacity decreases the color and Alpha values of the Face On material, making the material transparent.

Glancing Color
The Glancing Color defines the color of surface parts more perpendicular to the camera. If the Glancing material port has a valid input, then this input is multiplied by this color.

Reducing the material's opacity decreases the color and Alpha values of the Glancing material, making the material transparent.

Falloff
This value controls the transition between Glancing and Face On strength. It is very similar to a gamma operation applied to a gradient, blending one value into another.

Material ID
This slider sets the numeric identifier assigned to this material. This value is rendered into the MatID auxiliary channel if the corresponding option is enabled in the renderer.

Common Controls

Settings Tab
The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Fast Noise Texture [3FN]

The Fast Noise Texture node

Fast Noise Texture Node Overview
The Fast Noise Texture node is the procedural resolution-independent version of the 2D Fast Noise node. It creates a noise texture directly as a material for usage with 3D nodes. It offers a 3D volumetric mode for creating seamless textures in conjunction with nodes providing UVW texture coordinates (Similar to the UV Map 3D node set to XYZ-to-UVW or Camera).
**Inputs**

The Fast Noise Texture node includes an optional input that can be used to connect a 2D image or material.

- **SourceMaterial**: The Source Materials input accepts a 2D image or a 3D material. The image is then altered by the noise pattern.

**Basic Node Setup**

The Fast Noise Texture node below is used to generate a resolution-independent 3D texture for an FBX imported model.

A Fast Noise Texture node generates a seamless texture, taking advantage of UVW coordinates.

**Inspector**

Fast Noise Texture controls

**Controls Tab**

The parameters of the Fast Noise Texture node control the appearance and, for 2D, the animation of the noise.

**Output Mode**

- **2D**: Calculates the noise texture based on 2D texture coordinates (UV). This setting allows smoothly varying the noise pattern with animation.

- **3D**: Calculates the noise texture based on 3D texture coordinates (UVW). Nodes like Shape 3D automatically provide a third texture coordinate; otherwise, a 3D texture space can be created using the UV Map node. The 3D setting does not support animation of the noise pattern.
Detail
Increase the value of this slider to produce a greater level of detail in the noise result. Larger values add more layers of increasingly detailed noise without affecting the overall pattern. High values take longer to render but can produce a more natural result (not all graphics cards support higher detail levels in hardware).

Brightness
This control adjusts the overall Brightness of the noise map.

Contrast
This control increases or decreases the overall Contrast of the noise map. It can exaggerate the effect of the noise.

Scale
The scale of the noise map can be adjusted using the Scale slider, changing it from gentle variations over the entire image to a tighter overall texture effect. This value represents the scale along the UV axis.

Scale Z
(3D only) The Scale Z value scales the noise texture along the W-axis in texture space. W represents a direction perpendicular to the UV plane for a 3D texture map.

Seethe
(2D only) The Seethe control smoothly varies the 2D noise pattern.

Seethe Rate
(2D only) As with the Seethe control above, the Seethe Rate also causes the noise map to evolve and change. The Seethe Rate defines the rate at which the noise changes each frame, causing an animated drift in the noise automatically, without the need for spline animation.

Discontinuous
Normally, the noise function interpolates between values to create a smooth continuous gradient of results. You can enable the Discontinuous checkbox to create hard discontinuity lines along some of the noise contours. The result is a dramatically different effect.

Invert
Enable the Invert checkbox to invert the noise, creating a negative image of the original pattern. This is most effective when Discontinuous is also enabled.

Material ID
This slider sets the numeric identifier assigned to this material. This value is rendered into the MatID auxiliary channel if the corresponding option is enabled in the renderer.

Common Controls
Settings Tab
The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
Gradient Node Overview

The Gradient 3D node is used to texture objects with a variety of gradient types. It offers many of the same controls as the Background node. While it is not possible to transform the gradient directly in 3D space, it is orientable using the following nodes:

- **Texture Transform Node:** The Texture Transform node can be used to adjust the mapping per pixel.
- **UV Map Node:** The UV Map node can be used to adjust the mapping per vertex (use the XYZtoUVW mode). This has onscreen controls, so you can see what the gradient is doing. Using this node is recommended because it is faster to evaluate.

The gradient defaults to a linear gradient that goes from -1 to +1 along the Z-axis. All primitives in the Shape 3D node can output a third texture coordinate for UVW mapping.

Inputs

The Gradient node has no Inputs. The output of the node is connected to a material input on 3D geometry.

Basic Node Setup

The Gradient 3D node below is used to generate a resolution-independent 3D texture for an FBX imported model. Positioning in UVW space is easiest to do using a UV Map tool placed after the geometry.

A Gradient 3D node generates a resolution-independent gradient texture positioned by the UV Map tool.
Inspector

Gradient 3D controls

Controls Tab
The Controls tab for the Gradient node control the pattern and colors used for the gradient texture.

Gradient Type
Determines the type or pattern used for the gradient.

- **Linear**: A simple linear gradient.
- **Reflect**: Based on the Linear mode, this gradient is mirrored at the middle of the textured range.
- **Square**: The gradient is applied using a square pattern.
- **Cross**: Similar to the Reflect mode, but Cross uses two axes to apply the gradient.
- **Radial**: The Radial mode uses a circular pattern to apply the gradient.

Gradient 3D modes

Gradient Bar
The Gradient control consists of a bar where it is possible to add, modify, and remove color stops of the gradient. Each triangular color stop on the Gradient bar represents a color in the gradient. It is possible to animate the color as well as the position of the point. Furthermore, a From Image modifier can be applied to the gradient to evaluate it from an image.
**Interpolation Space**

The gradient is linearly interpolated from point to point in RGB color space by default. This can sometimes lead to unwanted colors. Choosing another color space may provide a better result.

**Scale**

Allows sizing of the gradient.

**Offset**

Allows panning through the gradient.

**Repeat**

Defines how the left and right borders of the gradient are treated.

![Gradients set to Once, Repeat, and Ping Pong from top to bottom, respectively, and shifting the gradient to the left](image)

- **Once**: When using the Gradient Offset control to shift the gradient, the border colors keep their values. Shifting the default gradient to the left results in a white border on the left, while shifting it to the right results in a black border on the right.

- **Repeat**: When using the Gradient Offset control to shift the gradient, the border colors wrap around. Shifting the default gradient to the left results in a sharp jump from white to black, while shifting it to the right results in a sharp jump from black to white.

- **Ping Pong**: When using the Gradient Offset control to shift the gradient, the border colors ping-pong back and forth. Shifting the default gradient to the left results in the edge fading from white back to black, while shifting it to the right results in the edge fading from black back to white.

**Sub Pixel**

Determines the accuracy with which the gradient is created.

**Material ID**

This slider sets the numeric identifier assigned to this material. This value is rendered into the MatID auxiliary channel if the corresponding option is enabled in the renderer.

**Common Controls**

**Settings Tab**

The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
**Sphere Map [3SPM]**

The Sphere Map node can be used to create simulated environment mapping, also called reflection mapping. Ray trace rendering a reflective scene can be very time consuming, but sphere map-based reflection mapping can generate 360-degree reflections faster with little loss of accuracy. For example, when creating a reflective environment, a sphere map is created, large enough to surround the 3D object in your scene. The sphere is mapped with the environment you want reflected and connected to the Reflection Color input on a Reflect node.

**Inputs**

The single image input on the Sphere Map node accepts a 2D image texture in an equirectangular format (where the X-axis represents 0–360 degrees longitude, and the Y-axis represents –90 to +90 degrees latitude.)

- **Image Input**: The orange Image input accepts a 2D RGBA image. Preferably, this is an equirectangular image that shows the entire vertical and horizontal angle of view up to 360 degrees.

**Basic Node Setup**

The Sphere Map node below is mapped with a spherical image to generate the environment reflected on the Shape 3D. It is connected to the Reflection Color input on a Reflect node.

A Sphere Map node generates a reflective environment when connected to a Reflect node Reflection Color input.
Inspector

Sphere Map controls

Controls Tab
The Controls tab in the Inspector modifies the mapping of the image input to the sphere map.

Angular Mapping
Adjusts the texture coordinate mapping so the poles are less squashed and areas in the texture get mapped to equal areas on the sphere. It turns the mapping of the latitude lines from a hemispherical fisheye to an angular fisheye. This mapping attempts to preserve area and makes it easier to paint on or modify a sphere map since the image is not as compressed at the poles.

Rotation
Offers controls to rotate the texture map.

Material ID
This slider sets the numeric identifier assigned to this material. This value is rendered into the MatID auxiliary channel if the corresponding option is enabled in the renderer.

The node expects an image with an aspect ratio of 2:1. Otherwise, the image is clamped according to the following rules:
- \(2 \times \text{width} > \text{height}\): The width is fitted onto the sphere, and the poles display clamped edges.
- \(2 \times \text{width} < \text{height}\): The height is fitted onto the sphere, and there is clamping about the 0-degree longitude line.

Common Controls

Settings tab
The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
Sphere Map vs. Connecting the Texture to a Sphere Directly

You can connect an equirectangular texture map directly to a sphere instead of piping it through the Sphere Map node first. This results in a different rendering if you set the start/end angle and latitude to less than 360°/180°. In the first case, the texture is squashed. When using the Sphere Map node, the texture is cropped. Compare:

NOTE: If you pipe the texture directly into the sphere, it is also mirrored horizontally. You can change this by using a Transform node first.

Texture 2D [3Tx]

The Texture 2D node

Texture Node Overview

The Texture 2D node sets metadata of an image being used for a texture map. By default, an image will be (0,0) to (1,1) UV, but that can be changed. The Texture node relies on the presence of U and V Map channels in 3D rendered images. If these channels are not present, this node has no effect.

NOTE: Background pixels may have U and V values of 0.0, which set those pixels to the color of the texture’s corner pixel. To restrict texturing to specific objects, use an effect mask based on the Alpha of the object, or its Object or Material ID channel. For more information, see Chapter 18, “Understanding Image Channels” in the Fusion Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.
Inputs
- **Image Input**: The orange image input expects a 2D image.

Basic Node Setup
The Texture 2D node below takes a 2D gradient from the Background node and sets the UV metadata for it. The texture is then applied to the FBX geometry based on that metadata. If you have the option to use the UV Map tool, it is recommended because it may be faster and has onscreen controls.

A Texture 2D node is used to set the 3D texture metadata for the input image.

Inspector
Texture 2D controls

Controls Tab
The Controls tab of the Inspector includes the following options.

**U/V Offset**
These sliders can be used to offset the texture along the U and V coordinates.

**U/V Scale**
These sliders can be used to scale the texture along the U and V coordinates.
Wrap Mode
If a texture is transformed in the texture space (using the controls below or the UV Map node), then it’s possible that areas beyond the image borders will be mapped on the object. The Wrap Mode determines how the image is applied in these areas.

- **Wrap**: This wraps the edges of the image around the borders of the image.
- **Clamp**: The color at the edges of the images is used for texturing. This mode is similar to the Duplicate mode in the Transform node.
- **Black**: The image is clipped along its edges. A black color with Alpha = 0 is used instead.
- **Mirror**: The image is mirrored in both X and Y.

Texture Filtering Mode
The texture can be filtered differently depending on whether you are using the Software Renderer or OpenGL renderer in the Renderer 3D node. Within the two render engines, you can choose between high-quality anti-aliasing or low quality. The texture filtering mode provides different filtering options for the two render engines and the two anti-aliasing settings.

- **Nearest**: The simplest filtering technique is very fast but can cause artifacts when scaling textures.
- **Bilinear**: A standard isotropic filtering technique for scaling textures into multiple resolutions. Works well for magnification of textures.
- **Trilinear**: An extension of Bilinear filtering. Trilinear tends to be a better option when scaling down textures
- **Anisotropic**: The highest-quality filtering method that takes the camera orientation and polygon perspective into account.
- **SAT**: SAT (Summed Area Table) is a method of performing high-quality filtering, but it can require more memory than other options. Works very well on smaller bitmaps.

Common Controls

Settings Tab
The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Texture Transform [3TT]

The Texture Transform node

Texture Transform Node Overview
The Texture Transform node can be used to translate, rotate, and scale the UVW texture coordinates of a 3D object. While the input can also be an image, the output is always a material.
Inputs
The Texture Transform node includes a single input that is used to connect the image or material you want to transform.

- **Material Input:** The orange Material input accepts a 2D image or 3D material whose texture coordinates are transformed using the controls in the Inspector.

Basic Node Setup
The Texture Transform node below is used to take in a 2D image, transform it, and output a material to be used on 3D geometry.

A Texture Transform node transforms a texture applied to 3D geometry.

Inspector

Texture Transform controls

**NOTE:** Not all Wrap modes are supported by all graphics cards.
Controls Tab
The Controls tab for the Texture Transform node includes many common transform controls that are used to transform the texture using UVW coordinates.

Translation
The U, V, W translation sliders shift the texture along U, V, and W axes.

Rotation
Rotation Order buttons set the order in which the rotation is applied. In conjunction with the buttons, the UVW dials define the rotation around the UVW axes.

Scale
U, V, W sliders scale the texture along the UVW axes.

Pivot
U, V, W Pivot sets the reference point for rotation and scaling.

Material ID
This slider sets the numeric identifier assigned to this material. This value is rendered into the MatID auxiliary channel if the corresponding option is enabled in the renderer.

Common Controls

Settings Tab
The Settings tab in the Inspector is duplicated in other 3D nodes. These common controls are described in the following “The Common Controls” section.

The Common Controls
Nodes that handle 3D geometry share a number of identical controls in the Inspector. This section describes controls that are common among 3D Texture nodes.

Settings Tab
The Common Settings tab can be found on most tools in Fusion. The following controls are specific settings for 3D nodes.

**Hide Incoming Connections**
Enabling this checkbox can hide connection lines from incoming nodes, making a node tree appear cleaner and easier to read. When enabled, fields for each input on a node are displayed. Dragging a connected node from the node tree into the field hides that incoming connection line as long as the node is not selected in the node tree. When the node is selected in the node tree, the line reappears.

**Comment Tab**
The Comment tab contains a single text control that is used to add comments and notes to the tool. When a note is added to a tool, a small red dot icon appears next to the setting's tab icon, and a text bubble appears on the node. To see the note in the Node Editor, hold the mouse pointer over the node for a moment. The contents of the Comments tab can be animated over time, if required.

**Scripting Tab**
The Scripting tab is present on every tool in Fusion. It contains several edit boxes used to add scripts that process when the tool is rendering. For more details on the contents of this tab, please consult the scripting documentation.
This chapter details the Blur nodes available in Fusion. The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

Blur [Blur] 1794
Defocus [DFO] 1796
Directional Blur [DRBL] 1798
Glow [GLO] 1801
Sharpen [SHRP] 1804
Soft Glow [SGlo] 1806
Unsharp Mask [USM] 1809
Vari Blur [VBL] 1810
Vector Motion Blur [VBL] 1812
The Common Controls 1814
Blur Node Introduction

The Blur node does exactly what its name implies – it blurs the input image. This is one of the most commonly used image-processing operations.

Inputs

The two inputs on the Blur node are used to connect a 2D image and an effect mask that can be used to limit the blurred area.

- **Input**: The orange input is used for the primary 2D image that is blurred.
- **Effect Mask**: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the blur to only those pixels within the mask. An effect mask is applied to the tool after the tool is processed.

Basic Node Setup

The Blur node, like many 2D image-processing nodes, receives a 2D image like the MediaIn1 shown below. The output continues the node tree by connecting to another 2D image-processing node or a Merge node.

Inspector

Blur controls
NOTE: Since a perfect Gaussian filter would require examining an infinite number of pixels, all practical Gaussians are, of necessity, approximations. The algorithm Fusion uses is a highly-optimized approach that has many strengths, but can create visible ringing around the edges in certain extreme cases. This ringing appears only when blurring float-depth images and is normally far below the limits of visibility, especially in final renders or HiQ mode, but may appear in subsequent processing. If you experience this, selecting the Multi-box filter may be a good choice.

Controls Tab
The Controls tab contains the primary controls necessary for customizing the blur operation, including five filter algorithms.

Filter
The Filter menu is where you select the type of filter used to create the blur.

- **Box Blur**: This option is faster than the Gaussian blur but produces a lower-quality result.
- **Bartlett**: This option is a more subtle, anti-aliased blur filter.
- **Multi-box**: Multi-box uses a Box filter layered in multiple passes to approximate a Gaussian shape. With a moderate number of passes (e.g., four), a high-quality blur can be obtained, often faster than the Gaussian filter and without any ringing.
- **Gaussian**: Gaussian applies a smooth, symmetrical blur filter, using a sophisticated constant-time Gaussian approximation algorithm.
- **Fast Gaussian**: Gaussian applies a smooth, symmetrical blur filter, using a sophisticated constant-time Gaussian approximation algorithm. This mode is the default filter method.

Color Channels (RGBA)
The filter defaults to operating on R, G, B, and A channels. Selective channel filtering is possible by clicking each channel button to make them active or inactive.

NOTE: This is not the same as the RGBA checkboxes found under the common controls. The node takes these selections into account before it processes the image, so deselecting a channel causes the node to skip that channel when processing, speeding up the rendering of the effect. In contrast, the channel controls under the Common Controls tab are applied after the node has processed.

Lock X/Y
Locks the X and Y Blur sliders together for symmetrical blurring. This is enabled by default.

Blur Size
Sets the amount of blur applied to the image. When the Lock X and Y control is deselected, independent control over each axis is provided.

Clipping Mode
This option determines how edges are handled when performing domain-of-definition rendering. This is profoundly important for nodes like Blur, which may require samples from portions of the image outside the current domain.
Frame: The default option is Frame, which automatically sets the node's domain of definition to use the full frame of the image, effectively ignoring the current domain of definition. If the upstream DoD is smaller than the frame, the remaining area in the frame is treated as black/transparent.

Domain: Setting this option to Domain respects the upstream domain of definition when applying the node's effect. This can have adverse clipping effects in situations where the node employs a large filter.

None: Setting this option to None does not perform any source image clipping at all. This means that any data required to process the node's effect that would normally be outside the upstream DoD is treated as black/transparent.

Blend
The Blend slider determines the percentage of the affected image that is mixed with original image. It blends in more of the original image as the value gets closer to 0.

This control is a cloned instance of the Blend slider in the Common Controls tab. Changes made to this control are simultaneously made to the one in the common controls.

Examples
Following is a comparison of Blur filters visualized as "cross-sections" of a filtered edge. As you can see, Box creates a linear ramp, while Bartlett creates a somewhat smoother ramp. Multi-box and Gaussian are indistinguishable unless you zoom in really close on the slopes. They both lead to even smoother ramps, but as mentioned above, Gaussian overshoots slightly and may lead to negative values if used on floating-point images.

![Blur filters visualized as "cross sections" of a filtered edge](blur_filters_cross_sections.jpg)

Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other Blur nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

Defocus [DFO]

The Defocus node

Defocus Node Introduction
The Defocus node simulates the effects of an out-of-focus camera lens, including blooming and image flaring. It provides a fast Gaussian mode, as well as a more realistic but slower Lens mode.
**Inputs**
The two inputs on the Defocus node are for connecting a 2D image and an effect mask that can be used to limit the simulated defocused area.

- **Input:** The orange input is used for the primary 2D image for defocusing.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the defocus to only those pixels within the mask. An effect mask is applied to the tool after it is processed.

**Basic Node Setup**
The Defocus node receives a 2D image like the MediaIn1 shown below. The output continues the node tree by connecting to another 2D image-processing node or a Merge node.

![A Defocus node applied to a MediaIn1 node](image)

**Inspector**

**Controls Tab**
The Controls tab contains all the primary controls necessary for customizing the defocus operation.

**Filter**
Use this menu to select the exact method applied to create the defocus. Gaussian applies a simplistic effect, while Lens mode creates a more realistic defocus. Lens mode takes significantly longer than Gaussian.

**Lock X/Y**
When Lock X/Y is selected, this performs the same amount of defocusing to both the X- and Y-axis of the image. Deselect to obtain individual control.

**Defocus Size**
The Defocus Size control sets the size of the defocus effect. Higher values blur the image by greater amounts and produce larger blooms.
Bloom Level
The Bloom Level control determines the intensity and size of the blooming applied to pixels that are above the bloom threshold.

Bloom Threshold
Pixels with values above the set Bloom Threshold are defocused and have a glow applied (blooming). Pixels below that value are only defocused.

The following four lens options are available only when the Filter is set to Lens.

- **Lens Type**: The basic shape used to create the “bad bokeh” effect. This can be refined further with the Angle, Sides, and Shape sliders.

- **Lens Angle**: Defines the rotation of the shape. Best visible with NGon lens types. Because of the round nature of a circle, this slider has no visible effect when the Lens Type is set to Circle.

- **Lens Sides**: Defines how many sides the NGon shapes have. Best visible with NGon lens types. Because of the round nature of a circle, this slider has no visible effect when the Lens Type is set to Circle.

- **Lens Shape**: Defines how pointed the NGons are. Higher values create a more pointed, starry look. Lower values create smoother NGons. Best visible with NGon lens types and Lens Sides between 5 and 10. Because of the round nature of a circle, this slider has no visible effect when the Lens Type is set to Circle.

Clipping Mode
This option determines how edges are handled when performing domain-of-definition rendering. This is profoundly important for nodes like Blur, which may require samples from portions of the image outside the current domain.

- **Frame**: The default option is Frame, which automatically sets the node's domain of definition to use the full frame of the image, effectively ignoring the current domain of definition. If the upstream DoD is smaller than the frame, the remaining area in the frame is treated as black/transparent.

- **Domain**: Setting this option to Domain respects the upstream domain of definition when applying the node’s effect. This can have adverse clipping effects in situations where the node employs a large filter.

- **None**: Setting this option to None does not perform any source image clipping at all. This means that any data required to process the node’s effect that would normally be outside the upstream DoD is treated as black/transparent.

Common Controls
Settings Tab
The Settings tab in the Inspector is also duplicated in other Blur nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Directional Blur [DRBL]

The Directional Blur node
**Directional Blur Node Introduction**

This node is used to create Directional and Radial blurs. It is useful for creating simulated motion blur and light ray-type effects. Directional Blur affects all channels (RGBA).

**Inputs**

The two inputs on the Directional Blur node are used to connect a 2D image and an effect mask which can be used to limit the blurred area.

- **Input**: The orange input is used for the primary 2D image that has the directional blur applied.
- **Effect Mask**: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the directional blur to only those pixels within the mask. An effect mask is applied to the tool after it is processed.

**Basic Node Setup**

The Directional Blur node receives a 2D image like the MediaIn1 shown below. The output continues the node tree by connecting to another 2D image-processing node or a Merge node.

![A Directional Blur node applied to a MediaIn1 node](image)

**Inspector**

![Directional Blur controls](image)

**Controls Tab**

The Controls tab contains all the primary controls necessary for customizing the directional blur operation.
**Type**
This menu is used to select the type of directional blur to be applied to the image.

- **Linear**: Linear distorts the image in a straight line, resembling the scenery that appears in the window of a speeding train.
- **Radial**: Radial creates a distortion that originates at some arbitrary center, radiating outward the way that a view would appear if one were at the head of the train looking forward.
- **Centered**: The Centered button produces a similar result to linear, but the blur effect is equally distributed on both sides of the original.
- **Zoom**: Zoom creates a distortion in the scale of the image smear to simulate the zoom streaking of a camera filming with a slow shutter speed.

**Center X and Y**
This coordinate control and related viewer crosshair affects the Radial and Zoom Motion Blur types only. It is used to position where the blurring effect starts.

**Length**
Length adjusts the strength and heading of the effect. Values lower than zero cause blurs to head opposite the angle control. Values greater than the slider maximum may be typed into the slider’s edit box.

**Angle**
In both Linear and Center modes, this control modifies the direction of the directional blur. In the Radial and Zoom modes, the effect is similar to the camera spinning while looking at the same spot. If the setting of the length slider is other than zero, the effect creates a whirlpool effect.

**Glow**
This adds a Glow to the directional blur, which can be used to duplicate the effect of increased camera exposure to light caused by longer shutter speeds.

**Clipping Mode**
This option determines how edges are handled when performing domain-of-definition rendering. This is profoundly important for nodes like Blur, which may require samples from portions of the image outside the current domain.

- **Frame**: The default option is Frame, which automatically sets the node’s domain of definition to use the full frame of the image, effectively ignoring the current domain of definition. If the upstream DoD is smaller than the frame, the remaining area in the frame is treated as black/transparent.
- **Domain**: Setting this option to Domain respects the upstream domain of definition when applying the node’s effect. This can have adverse clipping effects in situations where the node employs a large filter.
- **None**: Setting this option to None does not perform any source image clipping at all. This means that any data required to process the node’s effect that would normally be outside the upstream DoD is treated as black/transparent.

**Common Controls**

**Settings Tab**
The Settings tab in the Inspector is also duplicated in other Blur nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
Glow [GLO]

The Glow node

Glow Node Introduction

A Glow is created by blurring an image, and then brightening the blurred result and mixing it back with the original. The Glow node provides a variety of variations on this theme. For example, a Bartlett glow is a high-quality glow with a smoother drop-off; however, it is more processor-intensive at larger sizes.

Inputs

The Glow node has three inputs: an orange one for the primary 2D image input, a blue one for an effect mask, and a third white input for a Glow mask.

– **Input:** The orange input is used for the primary 2D image that has the glow applied.

– **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input restricts the source of the glow to only those pixels within the mask. An effect mask is applied to the tool after it is processed.

– **Glow Mask:** The Glow node supports pre-masking using the white glow mask input. A Glow pre-mask filters the image before applying the glow. The glow is then merged back over the original image. This is different from a regular effect mask that clips the rendered result.

The Glow mask allows the glow to extend beyond the borders of the mask, while restricting the source of the glow to only those pixels within the mask.

Glow masks are identical to Effect masks in every other respect.

Basic Node Setup

The Glow node receives a 2D image like the MediaIn1 shown below. The output continues the node tree by connecting to another 2D image-processing node or a Merge node.

A Glow node applied to a MediaIn1 node in DaVinci Resolve
Inspector

Controls Tab
The Controls tab contains all the primary controls necessary for customizing the glow operation. A Color Scale section at the bottom of the Inspector can be used for tinting the glow.

Filter
Use this menu to select the method of Blur used in the filter. The selections are described below.
- **Box**: A simple but very fast Box filter.
- **Bartlett**: Bartlett adds a softer, subtler glow with a smoother drop-off but may take longer to render than Box.
- **Multi-box**: Multi-box uses a Box filter layered in multiple passes to approximate a Gaussian shape. With a moderate number of passes (e.g., four), a high-quality blur can be obtained, often faster than the Gaussian filter, and without any ringing.
- **Gaussian**: Gaussian adds a soft glow, blurred by the Gaussian algorithm.
- **Fast Gaussian**: Fast Gaussian adds a soft glow, blurred by the Gaussian algorithm. This is the default method.
- **Blend**: Blend adds a nonlinear glow that is evenly visible in the whites and blacks.
- **Hilight**: Hilight adds a glow without creating a halo in the surrounding pixels.
- **Solarize**: Solarize adds a glow and solarizes the image.

Color Channels (RGBA)
This filter defaults to operating on R, G, B, and A channels. Selective channel filtering is possible by clicking each channel to make them active or inactive.

**NOTE**: This is not the same as the RGBA checkboxes found under the common controls. The node takes these selections into account before it processes the image, so deselecting a channel causes the node to skip that channel when processing, speeding up the rendering of the effect. In contrast, the channel controls under the Common Controls tab are applied after the node has processed.
**Lock X/Y**

When Lock X/Y is checked, both the horizontal and vertical glow amounts are locked. Otherwise, separate amounts of glow may be applied to each axis.

**Glow Size**

Glow Size determines the size of the glow effect. Larger values expand the size of the glowing highlights of the image.

**Num Passes**

Only available in Multi-box mode. Larger values lead to a smoother distribution of the effect, but also increase render times. It’s good to find the line between desired quality and acceptable render times.

**Glow**

The Glow slider determines the intensity of the glow effect. Larger values tend to completely blow the image out to white.

**Clipping Mode**

This option determines how edges are handled when performing domain-of-definition rendering. This is profoundly important for nodes like Blur, which may require samples from portions of the image outside the current domain.

- **Frame:** The default option is Frame, which automatically sets the node’s domain of definition to use the full frame of the image, effectively ignoring the current domain of definition. If the upstream DoD is smaller than the frame, the remaining area in the frame is treated as black/transparent.

- **Domain:** Setting this option to Domain respects the upstream domain of definition when applying the node’s effect. This can have adverse clipping effects in situations where the node employs a large filter.

- **None:** Setting this option to None does not perform any source image clipping at all. This means that any data required to process the node’s effect that would normally be outside the upstream DoD is treated as black/transparent.

**Blend**

The Blend slider determines the percentage of the affected image that is mixed with original image. It blends in more of the original image as the value gets closer to 0.

This control is a cloned instance of the Blend slider in the Common Controls tab. Changes made to this control are simultaneously made to the one in the common controls.

**Apply Mode**

Three Apply Modes are available when it comes to applying the glow to the image.

- **Normal:** Default. This mode simply adds the glow directly over top of the original image.

- **Merge Under:** Merge Under places the glow beneath the image, based on the Alpha channel. Threshold mode permits clipping of the threshold values.

- **Threshold:** This control clips the effect of the glow. A new range slider appears. Pixels in the glowed areas with values below the low value are pushed to black. Pixels with values greater than high are pushed to white.

- **High-Low Range Control:** Available only in Threshold mode. Pixels in the glowed areas with values below the low value are pushed to black. Pixels with values greater than high are pushed to white.
Color Scale (RGBA)
These Scale sliders can be used to adjust the amount of glow applied to each color channel individually, by tinting the glow.

Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other Blur nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Sharpen [SHRP]

Sharpen Node Introduction
The Sharpen node uses a convolution filter to enhance detail in an image overall or to an individual channel.

Inputs
The two inputs on the Sharpen node are used to connect a 2D image and an effect mask that can limit the area affected by the sharpen.

– **Input**: The orange input is used for the primary 2D image for sharpening.
– **Effect Mask**: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the sharpen to only those pixels within the mask. An effect mask is applied to the tool after it is processed.

Basic Node Setup
The Sharpen node receives a 2D image like the MediaIn1 shown below. The output continues the node tree by connecting to another 2D image-processing node or a Merge node.
Inspector

The Controls tab contains all the primary controls necessary for customizing the sharpen operation.

Color Channels (RGBA)
This filter defaults to operating on R, G, B, and A channels. Selective channel filtering is possible by clicking the channel buttons to make them active or inactive.

**NOTE:** This is not the same as the RGBA checkboxes found under the common controls. The node takes these selections into account before it processes the image, so deselecting a channel causes the node to skip that channel when processing, speeding up the rendering of the effect. In contrast, the channel controls under the Common Controls tab are applied after the node has processed.

Lock X/Y
This locks the X and Y Sharpen sliders together for symmetrical sharpening. This is checked by default.

Amount
This slider sets the amount of sharpening applied to the image. When the Lock X/Y control is deselected, independent control over each axis is provided.

Clipping Mode
This option determines how edges are handled when performing domain-of-definition rendering. This is profoundly important for nodes like Blur, which may require samples from portions of the image outside the current domain.

- **Frame:** The default option is Frame, which automatically sets the node’s domain of definition to use the full frame of the image, effectively ignoring the current domain of definition. If the upstream DoD is smaller than the frame, the remaining area in the frame is treated as black/transparent.
- **Domain:** Setting this option to Domain respects the upstream domain of definition when applying the node’s effect. This can have adverse clipping effects in situations where the node employs a large filter.
- **None:** Setting this option to None does not perform any source image clipping at all. This means that any data required to process the node’s effect that would normally be outside the upstream DoD is treated as black/transparent.
**Blend**

The Blend slider determines the percentage of the affected image that is mixed with original image. It blends in more of the original image as the value gets closer to 0.

This control is a cloned instance of the Blend slider in the Common Controls tab. Changes made to this control are simultaneously made to the one in the common controls.

**Common Controls**

**Settings Tab**

The Settings tab in the Inspector is also duplicated in other Blur nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

---

**Soft Glow [SGlo]**

The Soft Glow node

**Soft Glow Node Introduction**

The Soft Glow node is similar to the Glow node but performs additional processing of the image to create a much softer, more natural glow.

This node is perfect for atmospheric haze around planets, skin tones, and simulating dream like environments.

**Inputs**

Like the Glow node, Soft Glow also has three inputs: an orange one for the primary image input, a blue one for an effect mask, and a third white input for a Glow mask.

- **Input**: The orange input is used for the primary 2D image for the soft glow.
- **Effect Mask**: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the soft glow to only those pixels within the mask. An effect mask is applied to the tool after it is processed.
- **Glow Mask**: The Soft Glow node supports pre-masking using the white glow mask input. A Glow pre-mask filters the image before applying the soft glow. The soft glow is then merged back over the original image. This is different from a regular effect mask that clips the rendered result.

The Glow mask allows the soft glow to extend beyond the borders of the mask, while restricting the source of the soft glow to only those pixels within the mask.

Glow masks are identical to effect masks in every other respect.

**Basic Node Setup**

The Soft Glow node receives a 2D image like the MediaIn1 shown below. The output continues the node tree by connecting to another 2D image-processing node or a Merge node.
A Soft Glow node applied to a MediaIn1 node

Inspector

Soft Glow controls

Controls Tab
The Controls tab contains all the primary controls necessary for customizing the soft glow operation. A color scale section at the bottom of the Inspector can be used for tinting the soft glow.

Filter
Use this menu to select the method of Blur used in the filter. The selections are described below.

- **Box**: A simple but very fast Box filter.
- **Bartlett**: Bartlett adds a softer, subtler glow with a smoother drop-off but may take longer to render than Box.
- **Multi-box**: Multi-box uses a Box filter layered in multiple passes to approximate a Gaussian shape. With a moderate number of passes (e.g., four), a high-quality blur can be obtained, often faster than the Gaussian filter and without any ringing.
- **Gaussian**: Gaussian adds a soft glow, blurred by the Gaussian algorithm. This is the default method.

Color Channels (RGBA)
The filter defaults to operating on R, G, B, and A channels. Selective channel filtering is possible by clicking the channel buttons to make them active or inactive.

**NOTE**: This is not the same as the RGBA checkboxes found under the common controls. The node takes these selections into account before it processes the image, so deselecting a channel causes the node to skip that channel when processing, speeding up the rendering of the effect. In contrast, the channel controls under the Common Controls tab are applied after the node has processed.
Threshold
This control is used to limit the effect of the soft glow. The higher the threshold, the brighter the pixel must be before it is affected by the glow.

Gain
The Gain control defines the brightness of the glow.

Lock X/Y
When Lock X/Y is checked, both the horizontal and vertical glow amounts are locked. Otherwise, separate amounts of glow may be applied to each axis of the image.

Glow Size
This amount determines the size of the glow effect. Larger values expand the size of the glowing highlights of the image.

Num Passes
Available only in Multi-box mode. Larger values lead to a smoother distribution of the effect, but also increase render times. It’s good to find the line between desired quality and acceptable render times.

Clipping Mode
This option determines how edges are handled when performing domain-of-definition rendering. This is profoundly important for nodes like Blur, which may require samples from portions of the image outside the current domain.

- **Frame**: The default option is Frame, which automatically sets the node’s domain of definition to use the full frame of the image, effectively ignoring the current domain of definition. If the upstream DoD is smaller than the frame, the remaining area in the frame is treated as black/transparent.

- **Domain**: Setting this option to Domain respects the upstream domain of definition when applying the node’s effect. This can have adverse clipping effects in situations where the node employs a large filter.

- **None**: Setting this option to None does not perform any source image clipping at all. This means that any data required to process the node’s effect that would normally be outside the upstream DoD is treated as black/transparent.

Blend
The Blend slider determines the percentage of the affected image that is mixed with original image. It blends in more of the original image as the value gets closer to 0.

This control is a cloned instance of the Blend slider in the Common Controls tab. Changes made to this control are simultaneously made to the one in the common controls.

Color Scale (RGBA)
These Scale sliders are used to adjust the amount of glow applied to each color channel individually, by tinting the glow.

Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other Blur nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
Unsharp Mask [USM]

The Unsharp Mask node

Unsharp Mask Introduction

Unsharp masking is a technique used to sharpen only the edges within an image. This node is most often used to correct for blurring and loss of detail in low-contrast images; for example, to extract useful detail from long exposure shots of faraway galaxies.

This filter extracts a range of frequencies from the image and blurs them to reduce detail. The blurred result is then compared to the original images. Pixels with a significant difference between the original and the blurred image are likely to be an edge detail. The pixel is then brightened to enhance it.

Inputs

The two inputs on the Unsharp Mask node are used to connect a 2D image and an effect mask for limiting the effect.

- **Input**: The orange input is used for the primary 2D image for the Unsharp Mask.
- **Effect Mask**: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the Unsharp Mask to only those pixels within the mask. An effect mask is applied to the tool after it is processed.

Basic Node Setup

The Unsharp Mask node receives a 2D image like the MediaIn1 shown below. The output continues the node tree by connecting to another 2D image-processing node or a Merge node.

Inspector

Unsharp Mask controls
Controls Tab
The Controls tab contains all the primary controls necessary for customizing the Unsharp Mask operation.

Color Channels (RGBA)
The filter defaults to operating on R, G, B, and A channels. Selective channel filtering is possible by clicking the channel buttons to make them active or inactive.

NOTE: This is not the same as the RGBA checkboxes found under the common controls. The node takes these selections into account before it processes the image, so deselecting a channel causes the node to skip that channel when processing, speeding up the rendering of the effect. In contrast, the channel controls under the Common Controls tab are applied after the node has processed.

Lock X/Y
When Lock X/Y is checked, both the horizontal and vertical sharpen amounts are locked. Otherwise, separate amounts of glow may be applied to each axis of the image.

Size
This control adjusts the size of blur filter applied to the extracted image. The higher this value, the more likely it is that pixels are identified as detail.

Gain
The Gain control adjusts how much gain is applied to pixels identified as detail by the mask. Higher values create a sharper image.

Threshold
This control determines the frequencies from the source image to be extracted. Raising the value eliminates lower-contrast areas from having the effect applied.

Common Controls
Settings Tab
The Settings tab in the Inspector is also duplicated in other Blur nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Vari Blur [VBL]

Vari Blur Node Introduction
The Vari Blur node gives a true per-pixel variable blur, using a second image to control the amount of blur for each pixel. It is somewhat similar in effect to the Depth Blur node but uses a different approach for frequently cleaner results.
**Inputs**

There are two inputs on the Vari Blur node for the primary image: the blur map image, and an effect mask.

- **Input:** The gold image input is a required connection for the primary image you wish to blur.
- **Blur Image:** The green input is also required, but it can accept a spline shape, text object, still image, or movie file as the blur map image. Once connected, you can choose red, green, blue, Alpha, or luminance channel to create the shape of the blur.
- **Effect Mask:** The optional blue effect mask input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the Vari Blur to only those pixels within the mask. An effect mask is applied to the tool after it is processed.

**Basic Node Setup**

The Vari Blur node receives a 2D image like the MediaIn1 shown below. A gradient Background tool connects to the Blur image input to control the areas affected by the blur. The output continues the node tree by connecting to another 2D image-processing node or a Merge node.

![A Vari Blur node applied to a MediaIn1 node and a gradient background directing the blurred regions](image)

**Inspector**

![Vari Blur controls](image)

**Controls Tab**

The Controls tab contains all the primary controls necessary for customizing the Vari Blur operation.

**Method**

Use this menu to select the method of Blur used in the filter. The selections are described below.
– **Soften**: This method varies from a simple Box shape to a Bartlett triangle to a decent-looking Smooth blur as Quality is increased. It is a little better at preserving detail in less-blurred areas than Multi-box.

– **Multi-box**: Similar to Soften, this gives a better Gaussian approximation at higher Quality settings.

– **Defocus**: Produces a flat, circular shape to blurred pixels that can approximate the look of a defocus.

### Quality
Increasing Quality gives smoother blurs, at the expense of speed. Quality set to 1 uses a very fast but simple Box blur for all Method settings. A Quality of 2 is usually sufficient for low Blur Size values. A Quality of 4 is generally good enough for most jobs unless Blur Size is particularly high.

### Blur Channel
This selects which channel of the Blur Image controls the amount of blurring applied to each pixel.

### Lock X/Y
When selected, only a Blur Size control is shown, and changes to the amount of blur are applied to both axes equally. If the checkbox is cleared, individual controls appear for both X and Y Blur Size.

### Blur Size
Increasing this control increases the overall amount of blur applied to each pixel. Those pixels where the Blur image is black or nonexistent are blurred, despite the Blur Size.

### Blur Limit
This slider limits the useable range from the Blur image. Some Z-depth images can have values that go to infinity, which skew blur size. The Blur Limit is a way to keep values within range.

### Common Controls

### Settings Tab
The Settings tab in the Inspector is also duplicated in other Blur nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

## Vector Motion Blur [VBL]

![The Vector Motion Blur node](image)

### Vector Motion Blur Introduction
This node is used to create directional blurs based on a Motion Vector map or AOV (Arbitrary Output Variable) channels exported from 3D-rendering software like Arnold, Renderman, or VRay. You can also generate motion vectors using the Optical Flow node in Fusion.

The vector map is typically two floating-point images: one channel specifies how far the pixel is moving in X, and the other specifies how far the pixel is moving in Y. These channels may be embedded in OpenEXR or RLA/RPF images, or may be provided as separate images using the node’s Vectors input.
The vector channels should use a float16 or float32 color depth, to provide + and – values. A value of 1 in the X channel would indicate that pixel has moved one pixel to the right, while a value of –10 indicates ten pixels of movement to the left.

**Inputs**

The Vector Motion Blur node has three inputs for a 2D image, a motion vector pass, and an effect mask.

- **Input:** The required orange input is for a 2D image that receives the motion blur.
- **Vectors:** The green input is also required. This is where you connect a motion vector AOV rendered from a 3D application or an EXR file generated from the Optical Flow node in Fusion.
- **Vector Mask:** The white Vector Mask input is an optional input that masks the image before processing.
- **Effect Mask:** The common blue input is used for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input restricts the source of the motion blur to only those pixels within the mask. An effect mask is applied to the tool after it is processed.

**Basic Node Setup**

The Vector Motion Blur node receives a 2D image like the IMAGE shown below. A MediaIn or Loader node containing motion vectors is connected to the Vector’s input. The output continues the node tree by connecting to another 2D image-processing node or a Merge node.

A Vector Motion Blur node applied to a MediaIn or Loader node with motion vectors connected to the Vectors input

**Inspector**

Vector Motion Blur node

**Controls Tab**

The Controls tab contains all the primary controls necessary for customizing the Vector Motion Blur operation.
X Channel
Use this menu to select which channel of the image provides the vectors for the movement of the pixels along the X-axis.

Y Channel
Use this menu to select which channel of the image provides the vectors for the movement of the pixels along the Y-axis.

Flip Channel
These checkboxes can be used to flip, or invert, the X and Y vectors. For instance, a value of 5 for a pixel in the X-vector channel would become –5 when the X checkbox is enabled.

Lock Scale X/Y
Selecting this checkbox provides access to separate sliders for X and Y Scale. By default, only a single Scale slider is provided.

Scale
The X and Y vector channel values for a pixel are multiplied by the value of this slider. For example, given a scale of 2 and a vector value of 10, the result would be 20. This slider splits to show Scale X and Scale Y if the Lock Scale X/Y checkbox is not enabled.

Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other Blur nodes. These common controls are described in the following “The Common Controls” section.

The Common Controls

Nodes that handle blur operations share several identical controls in the Inspector. This section describes controls that are common among Blur nodes.

Inspector
Settings Tab
The Settings tab in the Inspector can be found on every tool in the Blur category. The Settings controls are even found on third-party Blur-type plug-in tools. The controls are consistent and work the same way for each tool.

Blend
The Blend control is used to blend between the tool's original image input and the tool's final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming image. Normally, this causes the tool to skip processing entirely, copying the input straight to the output.

Process When Blend Is 0.0
The tool is processed even when the input value is zero. This can be useful if processing of this node is scripted to trigger another task, but the value of the node is set to 0.0.

Red/Green/Blue/Alpha Channel Selector
These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.

For example, if the Red button on a Blur tool is deselected, the blur is first applied to the image, and then the red channel from the original input is copied back over the red channel of the result.

There are some exceptions, such as tools where deselecting these channels causes the tool to skip processing that channel entirely. Tools that do this generally possess a set of identical RGBA buttons on the Controls tab in the tool. In this case, the buttons in the Settings and the Controls tabs are identical.

Apply Mask Inverted
Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

Multiply by Mask
Selecting this option causes the RGB values of the masked image to be multiplied by the mask channel's values. This causes all pixels of the image not in the mask (i.e. set to 0) to become black/transparent.

Use Object/Use Material (Checkboxes)
Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports object and material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels are used, if present. The specific material ID or object ID affected is chosen using the next set of controls.

Correct Edges
This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information on Coverage and Background Color channels, see Chapter 18, "Understanding Image Channels" in the Fusion Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.
Object ID/Material ID (Sliders)

Use these sliders to select which ID is used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker to grab IDs from the image displayed in the viewer. The image or sequence must have been rendered from a 3D software package with those channels included.

Use GPU

The GPU menu has three settings. Disable turns off GPU hardware accelerated rendering. Enabled uses the GPU hardware for rendering the node. Auto uses a capable GPU if one is available and falls back to software rendering when a capable GPU is not available.

Motion Blur

- **Motion Blur**: This toggles the rendering of Motion Blur on the tool. When this control is toggled on, the tool’s predicted motion is used to produce the motion blur caused by the virtual camera’s shutter. When the control is toggled off, no motion blur is created.

- **Quality**: Quality determines the number of samples used to create the blur. A Quality setting of 2 causes Fusion to create two samples to either side of an object’s actual motion. Larger values produce smoother results but increase the render time.

- **Shutter Angle**: Shutter Angle controls the angle of the virtual shutter used to produce the motion blur effect. Larger angles create more blur but increase the render times. A value of 360 is the equivalent of having the shutter open for one whole frame exposure. Higher values are possible and can be used to create interesting effects.

- **Center Bias**: Center Bias modifies the position of the center of the motion blur. This allows the creation of motion trail effects.

- **Sample Spread**: Adjusting this control modifies the weighting given to each sample. This affects the brightness of the samples.

Comments

The Comments field is used to add notes to a tool. Click in the field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

Scripts

Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
Chapter 95

Color Nodes

This chapter details the Color nodes available in Fusion. The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

Auto Gain [AG] 1818
Brightness Contrast [BC] 1819
Channel Booleans [BOL] 1822
Color Corrector [CC] 1825
Color Curves [CCV] 1835
Color Gain [CLR] 1838
Color Matrix [CMX] 1842
Color Space [CS] 1846
Copy Aux [CPA] 1848
Gamut [GMT] 1852
Hue Curves [HCV] 1854
OCIO CDL Transform [OCD] 1857
OCIO Color Space [OCC] 1860
OCIO File Transform [OCF] 1862
Set Canvas Color [SCV] 1863
White Balance [WB] 1865
The Common Controls 1869
Auto Gain Node Introduction

The Auto Gain node automatically adjusts the tonal range of an image, setting the darkest and brightest pixels to user-selected values. By default, the darkest pixels get pushed to black, the brightest pixels get pushed to white, and pixels in between get stretched to cover the tonal range evenly.

This can be useful when compensating for variations in lighting, dealing with low-contrast images, or visualizing the full color range of float images (although the viewer’s View Normalized Image option is generally more suitable for this).

Inputs

The two inputs on the Auto Gain node are the input and effect mask.

– **Input:** The orange input connects the primary 2D image for the auto gain.

– **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the auto gain adjustment to only those pixels within the mask. An effect mask is applied to the tool after the tool is processed.

Basic Node Setup

The Auto Gain node, like many 2D image-processing nodes, receives a 2D image like a Loader node or the MediaIn1 shown below. The output continues the node tree by connecting to another 2D image-processing node or a Merge node.

Inspector

Auto Gain controls
Controls Tab
The Controls tab contains the few primary controls necessary for customizing the AutoGain operation.

**NOTE:** Variations over time in the input image can cause corresponding variations in the levels of the result. For example, if a bright object moves out of an otherwise dark shot, the remaining scene gets suddenly brighter, as the remaining darker values get stretched to white. This also applies to sudden depth changes when Do Z is applied; existing objects may be pushed forward or backward when a near or far object enters or leaves the scene.

Do Z
Select the Do Z checkbox to apply the Auto Gain effect to the Z or Depth channels. This can be useful for matching the ranges of one Z-channel to another, or to view a float Z-channel in the RGB values.

Range
This Range control sets the black point and white point in the image. All tonal values in the image rescale to fit within this range.

**Example**
Create a horizontal gradient with the Background node. Set one color to dark gray (RGB Values 0.2). Set the other color to light gray (RGB Values 0.8).

Add an Auto Gain node and set the Low value to 0.0 and the High value to 0.5. This causes the brightest pixels to be pushed down to 0.5, and the darkest pixels get pushed to black. The remainder of the pixel values scale between those limits.

Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other Color nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Brightness Contrast [BC]

**Brightness Contrast Node Introduction**
The Brightness Contrast node adjusts the gain, brightness, contrast, gamma, and saturation of an image. The order of the controls represents the order in which the operations are applied. For example, gamma gets applied before contrast but after gain. The Brightness Contrast is also reversible using the Forward and Reverse buttons. So color corrections, once applied, can be reversed further downstream.

For this to work best, image processing should operate in 32-bit floating point.
**Inputs**

The two inputs on the Brightness Contrast node are the input and effect mask.

- **Input:** The orange input connects the primary 2D image for the brightness contrast.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the Brightness Contrast adjustment to only those pixels within the mask. An effect mask is applied to the tool after the tool is processed.

**Basic Node Setup**

The Brightness Contrast node, like many 2D image-processing nodes, receives a 2D image like a Loader node or the MediaIn1 shown below. The output continues the node tree by connecting to another 2D image-processing node or a Merge node.

![A Brightness Contrast node applied to a MediaIn1 node](image)

**Inspector**

The Controls tab contains all the primary controls necessary for customizing the brightness, contrast operations.

**Color Channels (RGBA)**

The filter defaults to operating on R, G, B, and A channels. Selective channel filtering is possible by clicking each channel button to make them active or inactive.
**NOTE:** This is not the same as the RGBA checkboxes found under the common controls. The node takes these selections into account before it processes the image, so deselecting a channel causes the node to skip that channel when processing, speeding up the rendering of the effect. In contrast, the channel controls under the Common Controls tab get applied after the node has processed.

**Gain**
The gain slider is a multiplier of the pixel value. A Gain of 1.2 makes a pixel that is R0.5 G0.5 B0.4 into R0.6 G0.6, B0.48 (i.e., 0.4 * 1.2 = 0.48) while leaving black pixels unaffected. Gain affects higher values more than it affects lower values, so the effect is most influential in the midrange and top range of the image.

**Lift**
While Gain scales the color values around black, Lift scales the color values around white. The pixel values get multiplied by the value of this control. A Lift of 0.5 makes a pixel that is R0.0 G0.0 B0.0 into R0.5 G0.5, B0.5 while leaving white pixels unaffected. Lift affects lower values more than it affects higher values, so the effect is most influential in the midrange and low range of the image.

**Gamma**
Values higher than 1.0 raise the Gamma (mid-gray), whereas lower values decrease it. The effect of this node is not linear, and existing black or white points are not affected at all. Pure gray colors are affected the most.

**Contrast**
Contrast is the range of difference between the light to dark areas. Increasing the value of this slider increases the contrast, pushing color from the midrange toward black and white. Reducing the contrast causes the colors in the image to move toward midrange, reducing the difference between the darkest and brightest pixels in the image.

**Brightness**
The value of the Brightness slider gets added to the value of each pixel in the image. This control's effect on an image is linear, so the effect is applied identically to all pixels regardless of value.

**Saturation**
Use this control to increase or decrease the amount of Saturation in the image. A saturation of 0 has no color, reducing the image to grayscale.

**Low and High**
This range control is similar to the Gain control in some respects. If Low gets anchored at 0.0 and the High value gets reduced from 1.0, the effect is identical to increasing the gain. High values get multiplied by the inverse of the high value. (e.g., if high is 0.75, each pixel is multiplied by 1/0.75, or 1.3333).

Leaving the high anchored at 1.0 and increasing the low is the same as inverting the image colors and increasing the gain and inverting it back again. This pushes more of the image toward black without affecting the whites at all.

**Direction**
Forward applies all values normally. Reverse effectively inverts all values.

**Clip Black/White**
The Clip Black and Clip White checkboxes clip out-of-range color values that can appear in an image when processing in floating-point color depth. Out-of-range colors are below black (0.0) or above white (1.0). These checkboxes have no effect on images processed at 8-bit or 16-bit per channel, as such images cannot have out-of-range values.
Pre-Divide/Post-Multiply

Selecting the Pre-Divide/Post-Multiply checkbox causes the image pixel values to be divided by the Alpha values before the color correction, and then re-multiplied by the Alpha value after the correction.

This helps to prevent the creation of illegally additive images when color correcting images with premultiplied Alpha channels.

Common Controls

Settings Tab

The Settings tab in the Inspector appears in other Color nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Channel Booleans [BOL]

The Channel Booleans node

Channel Booleans Node Introduction

The Channel Booleans node applies a variety of mathematical and logical operations on the channels in an image. This node works by using one image’s channels to modify another image’s channels. If a foreground input is not available, selecting options that use color channels from the foreground ends up using the background input’s color channels instead.

NOTE: Be aware of another similarly named Channel Boolean (3Bol), which is a 3D node used to remap and modify channels of 3D materials. When modifying 2D channels, use the Channel Booleans (with an “s”) node (Bol).

Inputs

There are four inputs on the Channel Booleans node in the Node Editor, but only the orange Background input is required:

– **Background**: This orange input connects a 2D image that gets adjusted by the foreground input image.

– **Effect Mask**: The blue effect mask input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the channel booleans adjustment to only those pixels within the mask.

– **Foreground**: The green foreground input connects a 2D image that is used to adjust the background input image.

– **Matte**: The white matte input can be used to combine external mattes with the foreground and background operations.
Basic Node Setup

The Channel Booleans node is an extremely flexible tool used in many different ways. The example below copies the z-depth channel from the foreground input (green) into the background image (orange).

![A Channel Booleans set to copy from foreground to background](image)

Inspector

![Channel Booleans controls](image)

Color Channel Tab

On the Color Channels tab, the controls are divided into two columns. On the left side are target channels for the image connected into the orange background input. The drop-down menu to the right lets you choose whether you want to modify the BG image with its channels (suffix BG after list name) or with the channels from an image connected into the green foreground input on the node (suffix FG in the drop-down list).

**Operation**

This menu selects the mathematical operation applied to the selected channels. The options are as follows:

**Copy**

Copy the value from one color channel to another. For example, copy the foreground red channel into the background’s Alpha channel to create a matte.

- **Add**: Add the color values from one color channel to another channel.
- **Subtract**: Subtract the color values of one color channel from another color channel.
- **And**: Perform a logical AND on the color values from color channel to color channel. The foreground image generally removes bits from the color channel of the background image.
- **Or**: Perform a logical OR on the color values from color channel to color channel. The foreground image generally adds bits from the color channel of the background image.
– **Exclusive Or:** Perform a logical XOR on the color values from color channel to color channel. The foreground image generally flips bits from the color channel of the background image.

– **Multiply:** Multiply the values of a color channel. This gives the appearance of darkening the image as the values scale from 0 to 1. White has a value of 1, so the result would be the same. Gray has a value of 0.5, so the result would be a darker image or, in other words, an image half as bright.

– **Divide:** Divide the values of a color channel. This gives the appearance of lightening the image as the values scale from 0 to 1.

– **Maximum:** Compare the two images and take the maximum, or brightest, values from each image.

– **Minimum:** Compare the two images and take the minimum, or darkest, values from each image.

– **Negative:** Invert the FG input to make a negative version of the image.

– **Solid:** Solid sets a channel to a full value of 255. This is useful for setting the Alpha to full value.

– **Clear:** Clear sets a channel to a value of zero. This is useful for clearing the Alpha.

– **Difference:** Difference subtracts the greater color values of one color channel from the lesser values of another color channel.

– **Signed Add:** Signed Add subtracts areas that are lower than mid-gray and adds areas that are higher than mid-gray, which is useful for creating effects with embossed gray images.

**To Red, To Green, To Blue, To Alpha**

These menus represent the four color channels of the output image. Use the drop-down menu to select which channel from the source images produces the output channel.

The default setting copies the channels from the foreground channel. Select any one of the four color channels, as well as several auxiliary channels like Z-buffer, saturation, luminance, and hue.

**Inspector**

[Channel Boolean inspector with options]

Aux Channel Inspector
Aux Channel Tab
This tab includes a series of menus where you select a source for the auxiliary channels of the output image.

Enable Extra Channels
When the Enable Extra Channels checkbox is selected, the Channel Booleans node can output images with channels beyond the usual RGBA. Once enabled, the remaining controls in the Aux Channels tab can copy data into the auxiliary channels.

Examples
To copy the Alpha channel of one image to its color channels, set the red, green, and blue channels to Alpha BG. Set the Operation to Copy.

To copy the Alpha channel from another image, set operation type to Alpha FG.

To replace the existing Alpha channel of an image with the Alpha of another image, choose “Do Nothing” for To Red, To Green, and To Blue and “Alpha FG” for To Alpha. Pipe the image containing the Alpha into the foreground input on the Channel Booleans node. Set Operation: “Copy.” The same operation is available in the Matte Control node.

To combine any mask into an Alpha channel of an image, choose “Do Nothing” for To Red, To Green, and To Blue and “Matte” for To Alpha. Pipe the mask into the foreground input on the Channel Booleans node. Set Operation: “Copy.”

To subtract the red channel’s pixels of another image from the blue channel, choose “Do Nothing” for To Red and To Green and “Red FG” for To Blue. Pipe the image containing the red channel to subtract into the foreground input on the Channel Booleans node. Set Operation: “Subtract.”

Common Controls
Settings Tab
The Settings tab in the Inspector appears in other Color nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Color Corrector [CC]

Color Corrector Node Introduction
The Color Corrector node is a comprehensive color node with histogram matching, and equalization, hue shifting, tinting, and color suppression.

Controls in the Color Corrector node are separated into four tabs: Correction, Ranges, Options, and Settings.
**Inputs**

The Color Corrector node includes four inputs in the Node Editor.

- **Input:** This orange input is the only required connection. It connects a 2D image for color correction.

- **Effect Mask:** The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the color corrector adjustment to only those pixels within the mask. An effect mask is applied to the tool after the tool is processed.

- **Match Reference:** The green input is used to connect an image that can be a reference for histogram matching.

- **Match Mask:** This optional white input accepts any mask much like an effect mask. However, this mask defines the area to match during a Histogram Match. It offers more flexibility in terms of shape than the built-in Match rectangle in the Inspector.

**Basic Node Setup**

The Color Corrector node, like many 2D image-processing nodes, receives a 2D image like a Loader node or the MediaIn1 shown below. The output continues the node tree by connecting to another 2D image-processing node or a Merge node.

![A Color Corrector node applied to a MediaIn1 node](image)

**Inspector**

![Color Corrector controls](image)
Correction Tab Colors Menu

The main Correction tab is further separated into four types of correction methods: colors, levels, histogram, and suppress. Selecting one from the menu at the top of the Correction tab causes that method’s controls to appear. The Color method is described in detail below.

Range

This menu determines the tonal range affected by the color correction controls in this tab. The menu can be set to Shadows, Midtones, Highlights, and Master, where Master is the default affecting the entire image.

The selected range is maintained throughout the Colors, Levels, and Suppress sections of the Color Corrector node.

Adjustments made to the image in the Master channel are applied to the image after any changes made to the Highlight, Midtone, and Shadow ranges.

**NOTE:** The controls are independent for each color range. For example, adjusting the Gamma control while in Shadows mode does not change or affect the value of the Gamma control for the Highlights mode. Each control is independent and applied separately.

Color Wheel

The color wheel provides a visual representation of adjustments made to Hue and Saturation, as well as any tinting applied to the image. Adjustments can be made directly by dragging the color indicator, or by entering values in the numeric boxes under the color wheel.

The tinting is represented in the color wheel color indicator that shows the color and strength of the tint. The Highlight setting uses a black outline for the color indicator. The Midtones and Shadows use gray color indicators. The Master color indicator is also black, but it has a white M in the center to distinguish it from the others.

The mouse can position the color indicator for each range only when the applicable range is selected. For example, the Highlight color indicator cannot be moved when the Master range is selected.

Holding down the Command or Ctrl key while dragging this indicator allows you to make finer adjustments by reducing the control’s sensitivity to mouse movements. Holding down the Shift key limits the movement of the color indicator to a single axis, allowing you to restrict the effect to either tint or strength.

Tint Mode

This menu is used to select the speed and quality of the algorithm used to apply the hue and saturation adjustments. The default is Better, but for working with larger images, it may be desirable to use a faster method.

Hue

This slider is a clone of the Hue control located under the color wheel. The slider makes it easier to make small adjustments to the value with the mouse. The Hue control provides a method of shifting the hue of the image (or selected color range) through the color spectrum. The control value has an effective range between -0.1 and 1.0, which represents the angle of rotation in a clockwise direction. A value of 0.25 would be 90 degrees (90/360) and would have the effect of shifting red toward blue, green to red, and so on.

Hue shifting can be done by dragging the slider, entering a value directly into the text control, or by placing the mouse above the outer ring of the color wheel and dragging the mouse up or down. The outer ring always shows the shifted colors compared to the original colors shown in the center of the wheel.
**Saturation**
This slider is a clone of the Saturation control located under the color wheel. The slider makes it easier to make small adjustments to the value with the mouse. The Saturation control is used to adjust the intensity of the color values. A saturation of 0 produces gray pixels without any color component, whereas a value of 1.0 produces no change in the chroma component of the input image. Higher values generate oversaturated values with a high color component.

Saturation values can be set by dragging the slider, entering a value directly into the text control, or by dragging the mouse to the left and right on the outer ring of the color wheel control.

**Channel**
This menu is set for the Histogram, Color, and Levels sections of the Color Corrector node. When the red channel is selected, the controls in each mode affect the red channel only, and so on.

The controls are independent, so switching to blue does not remove or eliminate any changes made to red, green, or Master. The animation and adjustments made to each channel are separate. This menu simply determines what controls to display.

**Contrast**
Contrast is the range of difference between the light to dark areas. Increasing the value of this slider increases the contrast, pushing color from the midrange toward black and white. Reducing the contrast causes the colors in the image to move toward midrange, reducing the difference between the darkest and brightest pixels in the image.

**Gain**
The Gain slider is a multiplier of the pixel value. A gain of 1.2 makes a pixel that is R0.5 G0.5 B0.4 into R0.6 G0.6, B0.48 (i.e., 0.4 * 1.2 = 0.48), while leaving black pixels totally unaffected. Gain affects higher values more than it affects lower values, so the effect is strongest in the midrange and top range of the image.

**Lift**
While Gain scales the color values around black, Lift scales the color values around white. The pixel values are multiplied by the value of this control. A Lift of 0.5 makes a pixel that is R0.0 G0.0 B0.0 into R0.5 G0.5, B0.5, while leaving white pixels totally unaffected. Lift affects lower values more than it affects higher values, so the effect is strongest in the midrange and low range of the image.

**Gamma**
Values higher than 1.0 raise the Gamma (mid gray), whereas lower values decrease it. The effect of this node is not linear, and existing black or white points are not affected at all. Pure gray colors are affected the most.

**Brightness**
The value of the Brightness slider is added to the value of each pixel in your image. This control’s effect on an image is linear, so the effect is applied identically to all pixels despite value.

**Reset All Color Changes**
Selecting this button returns all color controls in this section to their default values.
Correction Tab Levels Menu

The main Correction tab is further separated into four types of correction methods: colors, levels, histogram, and suppress. When Levels is selected from the menu, you can remap the white and black points of an image, with a Gamma control to adjust midtones. A histogram provides a view of the tonal distribution in the image to help guide your adjustments. The Level method is described in detail below.

Range

Identical to the Range menu when Color is selected in the Menu, the Range menu determines the tonal range affected by the color correction controls in this tab. The menu can be set to Shadows, Midtones, Highlights, and Master, where Master is the default affecting the entire image.

The selected range is maintained throughout the Colors, Levels, and Suppress sections of the Color Corrector node.

Adjustments made to the image in the Master channel are applied to the image after any changes made to the Highlights, Midtones, and Shadows ranges.

NOTE: The controls are independent for each color range. For example, adjusting the Gamma control while in Shadows mode does not change or affect the value of the Gamma control for the Highlights mode. Each control is independent and applied separately.

Channel

This menu is used to select and display the histogram for each color channel or for the Master channel.

Histogram Display

A histogram is a chart that represents the distribution of color values in the scene. The chart reads from left to right, with the leftmost values representing the darkest colors in the scene and the rightmost values representing the brightest. The more pixels in an image with the same or similar value, the higher that portion of the chart is.

Luminance is calculated per channel; therefore, the red, green, and blue channels all have their own histogram, and the combined result of these comprises the Master Histogram.

To scale the histogram vertically, place the mouse pointer inside the control and drag the pointer up to zoom in or down to zoom out.
Display Selector Toolbar
The Display Selector toolbar at the top of the histogram provides a method of enabling and disabling components of the histogram display. Hold the mouse pointer over the button to display a tooltip that describes the button’s function.

- **Input Histogram**: This enables or disables the display of the input image’s histogram.
- **Reference Histogram**: This enables or disables the display of the reference image’s histogram.
- **Output Histogram**: This enables or disables the display of the histogram from the post-color-corrected image.
- **Corrective Curve**: This toggles the display of a spline used to visualize exactly how auto color corrections applied using a reference image are affecting the image. This can be useful when equalizing luminance between the input and reference images.

Histogram Controls
These controls along the bottom of the histogram display are used to adjust the input image’s histogram, compressing or shifting the ranges of the selected color channel.

The controls can be adjusted by dragging the triangles beneath the histogram display to the left and right.

Shifting the High value toward the left (decreasing the value) causes the histogram to slant toward white, shifting the image distribution toward white. The Low value has a similar effect in the opposite direction, pushing the image distribution toward black.

Output Level
The Output Level control can apply clipping to the image, compressing the histogram. Decreasing the High control reduces the value of pixels in the image, sliding white pixels down toward gray and gray pixels toward black.

Adjusting the Low control toward High does the opposite, sliding the darkest pixels toward white.

If the low value were set to 0.1, pixels with a value of 0.0 would be set to 0.1 instead, and other values would increase to accommodate the change. The best way to visualize the effect is to observe the change to the output histogram displayed above.

Reset All Levels
Clicking this button resets all the controls in the Levels section to their defaults.

![Color Correction in Histogram mode](image)
Correction Tab Histogram Menu

When the menu is set to Histogram, a histogram display is produced of the input image. If a reference image is also provided, the histogram for the reference image is also displayed. The controls in this tab are primarily used to match one image to another, using either the Equalize or Match modes of the Color Corrector.

Channel

This menu is used to select and display the histogram for each color channel or for the Master channel.

Histogram Display

A histogram is a chart that represents the distribution of color values in the scene. The chart reads from left to right, with the leftmost values representing the darkest colors in the scene and the rightmost values representing the brightest. The more pixels in an image with the same or similar value, the higher that portion of the chart is.

Luminance is calculated per channel; therefore, the red, green, and blue channels all have their own histogram, and the combined result of these comprises the Master Histogram.

To scale the histogram vertically, place the mouse pointer inside the control and drag the pointer up to zoom in or down to zoom out.

Display Selector Toolbar

The Display Selector toolbar at the top of the histogram provides a method of enabling and disabling components of the histogram display. Hold the mouse pointer over the button to display a tooltip that describes the button’s function.

- **Input Histogram:** This enables or disables the display of the input image’s histogram.
- **Reference Histogram:** This enables or disables the display of the reference image’s histogram.
- **Output Histogram:** This enables or disables the display of the histogram from the post-color-corrected image.
- **Corrective Curve:** This toggles the display of a spline used to visualize exactly how auto color corrections applied using a reference image are affecting the image. This can be useful when equalizing luminance between the input and reference images.

Float Images and Histogram Equalization or Matching

By using the Histogram Match or Equalize methods on a float image, the color depth of the output image is converted to 16-bit integer. Two-dimensional histograms are not well suited to working with the extreme dynamic range of float images, so these operations always revert to 16-bit integer processing.

Histogram Type

Each of these menu options enables a different type of color correction operation.

- **Keep:** Keep produces no change to the image, and the reference histogram is ignored.
- **Equalize:** Selecting Equalize adjusts the source image so that all the color values in the image are equally represented—in essence, flattening the histogram so that the distribution of colors in the image becomes more even.
- **Match:** The Match mode modifies the source image based on the histogram from the reference image. It is used to match two shots with different lighting conditions and exposures so that they appear similar.

When selected, the Equalize and Match modes reveal the following controls.
– **Match/Equalize Luminance:** This slider affects the degree that the Color Corrector node attempts to affect the image based on its luminance distribution. When this control is zero (the default), matching and equalization are applied to each color channel independently, and the luminance, or combined value of the three color channels, is not affected.

If this control has a positive value when equalizing the image, the input image’s luminance distribution is flattened before any color equalization is applied.

If this control has a positive value when the correction mode is set to Match, the luminance values of the input are matched to the reference before any correction is applied to the R, G, and B channels.

The Luminance and RGB controls can have a cumulative effect, and generally they are not both set to full (1.0) simultaneously.

– **Lock R/G/B:** When this checkbox is selected, color matching is applied to all color channels equally. When the checkbox is not selected, individual controls for each channel appear.

**Equalize/Match R/G/B**

The name of this control changes depending on whether the Equalize or Match modes have been selected. The slider can be used to reduce the correction applied to the image to equalize or match it. A value of 1.0 causes the full effect of the Equalize or Match to be applied, whereas lower values moderate the result.

**Precision**

This menu determines the color fidelity used when sampling the image to produce the histogram. 10-bit produces higher fidelity than 8-bit, and 16-bit produces higher fidelity than 10-bit.

**Smooth Correction**

Often, color equalization and matching operations introduce posterization in an image, which occurs because gradients in the image have been expanded or compressed so that the dynamic range between colors is not sufficient to display a smooth transition. This control can be used to smooth the correction curve, blending some of the original histogram back into the result for a more even transition.

**Snapshot Match Time**

Click this button to take a freeze snapshot of the current reference histogram, storing its current state as a snapshot in memory. If the reference histogram is not snapshot, the reference histogram is updated from frame to frame. This can cause flickering and phasing of the correction as the node tries to match a changing source to a changing reference.

**Release Match**

Click this button to release the current snapshot of the histogram and return to using the live reference input.

**Reset All Histogram Changes**

Selecting this button removes all changes made to the histogram, returning the controls to default and setting the mode back to Keep.

**Correction Tab Suppress Menu**

Color Suppression provides a mechanism for removing an unwanted color component from the image. The Color Wheel control is similar to that shown in the Colors section of the node, but this one is surrounded by six controls, each representing a specific color along the wheel.

To suppress a color in the selected range, drag the control that represents that color toward the center of the color wheel. The closer the control is to the center, the more that color is suppressed from the image.
Suppression Angle

Use the Suppression Angle control to rotate the controls on the suppression wheel and zero in on a specific color.

Reset All Suppression

Clicking this control resets the suppression colors to 1.0, the default value.

Ranges Tab

The Ranges tab contains the controls used to specify which pixels in an image are considered to be shadows and which are considered to be highlights. The midrange is always calculated as pixels not already included in the shadows or the highlights.

Range

This menu is used to select the tonal range displayed in the viewers. They help to visualize the pixels in the range. When the Result menu option is selected, the image displayed by the color corrector in the viewers is that of the color corrected image. This is the default.

Selecting one of the other menu options switches the display to a grayscale image showing which pixels are part of the selected range. White pixels represent pixels that are considered to be part of the range, and black pixels are not in the range. For example, choosing Shadows would show pixels
considered to be shadows as white and pixels that are not shadows as black. Mid gray pixels are only partly in the range and do not receive the full effect of any color adjustments to that range.

**Channel**

The Channel menu in this tab can be used to examine the range of a specific color channel. By default, Fusion displays the luminance channel when the color ranges are examined.

**Spline Display**

The ranges are selected by manipulating the spline handles. There are four spline points, each with one Bézier handle. The two handles at the top represent the start of the shadow and highlight ranges, whereas the two at the bottom represent the end of the range. The Bézier handles are used to control the falloff.

The midtones range has no specific controls since its range is understood to be the space between the shadow and the highlight ranges.

The X and Y text controls below the spline display can be used to enter precise positions for the selected Bézier point or handle.

**Output the Range You See Now as Final Render**

Selecting this checkbox causes the monochrome display of the range shown in the viewers to be output as the final render. Normally, the Color node outputs the full RGBA image, even if the node were left to display one of the color ranges in the view instead. This control makes it possible to use the Color Corrector node to generate a range’s matte for use as an effect mask in other nodes.

**Preset Simple/Smooth Ranges**

These two buttons can be used to return the spline ranges to either Smooth (default) or Simple (linear) settings.

---

**Options Tab**

The Options tab includes a few very important processing operations including a simple solution when color correcting premultiplied Alpha channels.

**Pre-Divide/Post-Multiply**

Selecting this option divides the color channels by the value of the Alpha before applying the color correction. After the color correction, the color values are re-multiplied by the Alpha to produce a properly additive image. This is crucial when performing an additive merge or when working with CG images generated with premultiplied Alpha channels.

**Histogram Proxy Scale**

The Histogram Proxy Scale determines the precision used when creating and calculating histograms. Lower values represent higher precision, and higher values produce a rougher, generalized histogram.
Process Order
This menu is used to select whether adjustments to the image’s gamma are applied before or after any changes made to the images levels.

Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other Color nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Color Curves [CCV]

Color Curves Node Introduction
The Color Curves node is a spline-based node for performing Lookup table (LUT) color manipulations. A separate spline is provided for each color channel. The effect can be animated or dissolved and can be applied to the image using RGB, YUV, YIQ, CMY, or HLS color spaces.

The LUT view in the Color Corrector can be scaled using the + and - keys on the numeric keypad. The color curves LUT fully supports out-of-range values—i.e., pixels with color values above 1.0 or below 0.0.

The splines shown in this LUT view are also available from the Spline Editor, should greater precision be required when adjusting the controls.

Inputs
The Color Curves node includes three inputs in the Node Editor.

– **Input**: This orange input is the only required connection. It connects a 2D image that is adjusted by the color curves.

– **Effect Mask**: The optional effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the color curves adjustment to only those pixels within the mask. An effect mask is applied to the tool after it is processed.

– **Reference Image**: The optional green input is used to connect a second 2D image that can be used for reference matching.

– **Match Mask**: This optional white input accepts any mask much like an effect mask. However, this mask defines the area to match during a Match. It offers more flexibility in terms of shape than the built-in Match reference rectangle in the Inspector.

Basic Node Setup
The Color Curves node, like many 2D image-processing nodes, receives a 2D image like a Loader node or the MediaIn1 shown below. The output continues the node tree by connecting to another 2D image-processing node or a Merge node.
Inspector

Controls Tab
The Controls tab for the color curves is divided into two sections. The top half of the Inspector includes the curves and LUT controls. The bottom half is dedicated primarily to matching the reference image.

Mode
The Mode options change between Animated and Dissolve modes. The default mode is No Animation, where adjustments to the curves are static. Setting the mode provides a change spline for each channel, allowing the color curve to be animated over time.

Dissolve mode is essentially obsolete and is included for compatibility reasons only.

Color Space
The splines in the LUT view represent color channels from a variety of color spaces. The default is Red, Green, and Blue. The options in this menu allow an alternate color space to be selected.
A detailed description of the color spaces available here are below:

- **RGB (Red, Green, Blue):** Fusion uses the RGB color space, and most nodes and displays interpret the primary channels of an image as Red, Green, and Blue.

- **YUV (Luma, Blue Chroma, and Red Chroma):** The YUV color space is used in the analog broadcast of PAL video. Historically, this format was often used to color correct images, because of its familiarity to a large percentage of video engineers. Each pixel is described in terms of its Luminance, Blue Chroma, and Red Chroma components.

- **HLS (Hue, Luminance, and Saturation):** Each pixel in the HLS color space is described in terms of its Hue, Luminance, and Saturation components.

- **YIQ (Luma, In Phase, and Quadrature):** The YIQ color space is used in the analog broadcast of NTSC video. This format is much rarer than YUV and almost never seen in production. Each pixel is described in terms of its Luminance, Chroma (in-phase or red-cyan channel) and Quadrature (magenta-green) components.

- **CMY (Cyan, Magenta, and Yellow):** Although more common in print, the CMY format is often found in computer graphics from other software packages. Each pixel is described in terms of its Cyan, Magenta, and Yellow components. CMY is nonlinear.

**Color Channels (RGBA)**

Use the Color Channel controls to select which channel’s spline is currently active for editing. The labels of these controls change to reflect the names of the channels for the current color space. Normally, they are read as Red, Green, and Blue. If the Color Curves node is operating in YUV color space, they are read as Y, U, and V instead.

These controls do not restrict the effect of the node to a specific channel. They only select whether the spline for that channel is editable. These controls are most often used to ensure that adding or moving points on one channel’s spline do not unintentionally affect a different channel’s spline.

**Spline Window**

The Spline Window displays a standard curve editor for each RGBA channel. These splines can be edited individually or as a group, depending on the color channels selected above.

The spline defaults to a linear range, from 0 in/0 out at the bottom left to the 1 in/1 out at the top right. At the default setting, a color processes to the same value as the output. If a point is added in the middle at 0.5 in/0.5 out, and the point is moved up, this raises the mid color of the image brighter.

The spline curves allow precise control over color ranges, so specific adjustments can be made without affecting other color values.

**In and Out**

Use the In and Out controls to manipulate the precise values of a selected point. To change a value, select a point and enter the in/out values desired.

**Eyedropper (Pick)**

Click the Eyedropper icon, also called the Pick button, and select a color from an image in the display to automatically set control points on the spline for the selected color. The new points are drawn with a triangular shape and can only be moved vertically (if point is locked, only the Out value can change).

Points are only added to enabled splines. To add points only on a specific channel, disable the other channels before making the selection.

One use for this technique is white balancing an image. Use the Pick control to select a pixel from the image that should be pure gray. Adjust the points that appear so that the Out value is 0.5 to change the pixel colors to gray.

Use the contextual menu’s Locked Pick Points option to unlock points created using the Pick option, converting them into normal points.
Reference

The Reference section includes controls that handle matching to sample areas of the connected reference image.

- **Match Reference:** The Match Reference button adds points on the curve to match an image connected to the green reference image input. The number of points used to match the image is based on the Number of Samples slider below.

- **Sample Reference:** Clicking the Sample Reference button samples the center scanline of the background image and creates a LUT of its color values. The number of points used to match the samples scanline is based on the Number of Samples slider below.

- **Number of Samples:** This slider determines how many points are used to match the curve to the range in the reference image.

- **Show Match Rectangle:** Enabling this checkbox displays a rectangle in the viewer showing the area on the reference image used during the match process. The match rectangle affects only the result of the Match Reference operation. The Sample reference is always done from the center scaling of the image.

- **Match Center:** The X and Y parameters allow you to reposition the match rectangle to sample a different area when matching.

- **Match Width:** Width controls the width of the match rectangle.

- **Match Height:** Height controls the height of the match rectangle.

- **Pre-Divide/Post-Multiply:** Selecting this checkbox causes the image’s pixel values to be divided by the Alpha values prior to the color correction, and then re-multiplied by the Alpha value after the correction. This helps to avoid the creation of illegally additive images, particularly around the edges of a blue/green key or when working with 3D-rendered objects.

Common Controls

**Settings Tab**

The Settings tab in the Inspector is also duplicated in other Color nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

**Color Gain [CLR]**

The Color Gain node

**Color Gain Node Introduction**

The Color Gain node contains options for adjusting the gain, gamma, saturation, and hue of the image. Many controls provided by the Color Gain node are also found in the Color Corrector node, but this simpler node may render more quickly. One feature that distinguishes the Color Gain node from the Color Corrector is its balance tab controls. These can be used to adjust the tinting of the colors in the highs, mids, and lows.
Inputs

The Color Gain node includes two inputs: one for the main image and the other for an effect mask.

- **Input:** This orange input is the only required connection. It connects a 2D image that gets adjusted by the color gain.

- **Effect Mask:** The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the color gain adjustment to only those pixels within the mask. An effect mask is applied to the tool after it is processed.

Basic Node Setup

The Color Gain node, like many 2D image-processing nodes, receives a 2D image like a Loader node or the MediaIn1 shown below. The output continues the node tree by connecting to another 2D-image processing node or a Merge node.

![A Color Gain node applied to a MediaIn1 node](image)

Inspector

![Color Gain controls](image)

Gain Tab

The Gain tab provides control of individual RGBA Lift/Gamma/Gain parameters. These controls can quickly enable you to fix irregular color imbalances in specific channels.
Lock R/G/B
When selected, the Red, Green, and Blue channel controls for each effect are combined into one slider. Alpha channel effects remain separate.

Gain RGBA
The Gain RGBA controls multiply the values of the image channel in a linear fashion. All pixels are multiplied by the same factor, but the effect is larger on bright pixels and smaller on dark pixels. Black pixels do not change because multiplying any number times 0 is always 0.

Lift RGBA
While Gain scales the color values around black, Lift scales the color values around white. The pixel values are multiplied by the value of this control. A Lift of 0.5 makes a pixel that is R0.0 G0.0 B0.0 into R0.5 G0.5, B0.5, while leaving white pixels totally unaffected. Lift affects lower values more than it affects higher values, so the effect is strongest in the midrange and low range of the image.

Gamma RGBA
The Gamma RGBA controls affect the brightness of the midrange in the image. The effect of this node is nonlinear. White and black pixels in the image are not affected when gamma is modified, whereas pure grays are affected most by changes to this parameter. Large changes to this control tend to push midrange pixels into black or white, depending on the value used.

Pre-Divide/Post-Multiply
Selecting this checkbox causes the image pixel values to be divided by the Alpha values prior to the color correction, and then re-multiplied by the Alpha value after the correction. This helps when attempting to color correct images with premultiplied Alpha channels.

Saturation Tab
This Setting tab includes controls for the intensity of the colors in the individual RGB channels.

RGB Saturation
When adjusting an individual channel, a value of 0.0 strips out all that channel’s color. Values greater than one intensify the color in the scene, pushing it toward the primary color.

Balance Tab
This tab in the Color Gain node offers controls for adjusting the overall balance of a color channel. Independent color and brightness controls are offered for the High, Mid, and Dark ranges of the image.

Colors are grouped into opposing pairs from the two dominant color spaces. Red values can be pushed toward Cyan, Green values toward Magenta and Blue toward Yellow. Brightness can be raised or lowered for each of the channels.
**CMY Brightness Highs/Mids/Darks**
By default, the Balance sliders can be adjusted by -1 to +1, but values outside this range can be entered manually to increase the effect. A value of 0.0 for any slider indicates no change to the image channel. Positive and negative values indicate that the balance of the image channel has been pushed toward one color or the other in the pair.

**Hue Tab**
Use the Hue tab of the Color Gain node to shift the overall hue of the image, without affecting the brightness, or saturation. Independent controls of the High, Mid, and Dark ranges are offered by three sliders.

The following is the order of the hues in the RGB color space: Red, Yellow, Green, Cyan, Blue, Magenta and Red.

**High/Mid/Dark Hue**
Values above 0 push the hue of the image toward the right (red turns yellow). Values below 0 push the hue toward the left (red turns magenta). At -1.0 or 1.0, the hue completes the cycle and returns to its original value.

The default range of the hue sliders is -1.0 to +1.0. Values outside this range can be entered manually.
Ranges Tab

The Ranges tab contains the controls used to specify which pixels in an image are considered to be shadows and which are considered to be highlights. The midrange is always calculated as pixels not included in either the shadows or the highlights.

Spline Display

The ranges are selected by manipulating the spline handles. There are four spline points, each with one Bézier handle. The two handles at the top represent the start of the shadow and highlight ranges, whereas the two at the bottom represent the end of the range. The Bézier handles are used to control the falloff.

The midtones range has no specific controls since its range is understood to be the space between the shadow and the highlight ranges. The X and Y text controls below the Spline display can be used to enter precise positions for the selected Bézier point or handle.

Preset Simple/Smooth Ranges

These two buttons can be used to return the spline ranges to either Smooth (default) or Simple (linear) settings.

Settings Tab

The Settings tab in the Inspector is also duplicated in other Color nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Color Matrix [CMX]

Color Matrix Node Introduction

The ColorMatrix allows a vast number of operations to modify values individually in the different color channels.
**Inputs**

The Color Matrix node includes two inputs: one for the main image and the other for an effect mask.

- **Input:** This orange input is the only required connection. It connects a 2D image that is adjusted by the color matrix.

- **Effect Mask:** The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the color matrix adjustment to only those pixels within the mask. An effect mask is applied to the tool after it is processed.

**Basic Node Setup**

The Color Matrix node, like many 2D image-processing nodes, receives a 2D image like a Loader node or the MediaIn1 shown below. The output continues the node tree by connecting to another 2D image-processing node or a Merge node.

![A Color Matrix node applied to a MediaIn1 node](image)

**Inspector**

![Color Matrix controls](image)

**Controls Tab**

Color Matrix multiplies the RGBA channels based on the values entered in a 4 x 4 grid. The fifth column/row is an Add column.

**Update Lock**

When this control is selected, Fusion does not render the node. This is useful for setting up each value of the node, and then turning off Update Lock to render it.

**Matrix**

This defines what type of operation actually takes place. The horizontal rows define the output values of the node. From left to right, they are R, G, B, A, and Add. The vertical columns define the input values. From top to bottom, they are R, G, B, A, and Add. The Add column allows simple adding of values to the individual color channels.
By default, the output values are identical to the input values.

- 1.0 means 100% of the Red channel input is copied to the Red channel output.
- 1.0 means 100% of the Green channel input is copied to the Green channel output.
- 1.0 means 100% of the Blue channel input is copied to the Blue channel output.
- 1.0 means 100% of the Alpha channel input is copied to the Alpha channel output.

Written as mathematical equations, the default settings of the matrix would appear as follows:

\[
\begin{align*}
[R \text{ out}] &= 1 \cdot [R \text{ in}] + 0 \cdot [G \text{ in}] + 0 \cdot [B \text{ in}] + 0 \cdot [A \text{ in}] + 0 \\
[G \text{ out}] &= 0 \cdot [R \text{ in}] + 1 \cdot [G \text{ in}] + 0 \cdot [B \text{ in}] + 0 \cdot [A \text{ in}] + 0 \\
[B \text{ out}] &= 0 \cdot [R \text{ in}] + 0 \cdot [G \text{ in}] + 1 \cdot [B \text{ in}] + 0 \cdot [A \text{ in}] + 0 \\
[A \text{ out}] &= 0 \cdot [R \text{ in}] + 0 \cdot [G \text{ in}] + 0 \cdot [B \text{ in}] + 1 \cdot [A \text{ in}] + 0
\end{align*}
\]

**Invert**

Enabling this option inverts the Matrix. Think of swapping channels around, doing other operations with different nodes, and then copying and pasting the original ColorMatrix and setting it to Invert to get your channels back to the original.

**Example 1: Invert**

If you want to do a simple invert or negative of the color values, but leave the Alpha channel untouched, the matrix would look like this:

Observe the fact that we have to add 1 to each channel to push the inverted values back into the positive numbers.

Let’s follow this example step by step by viewing the waveform of a 32-bit grayscale gradient.

1. The original grayscale.
2 RGB set to -1. The values get inverted but fall below 0.

3 Adding 1 to each channel keeps the inversion but moves the values back into a positive range.

Example 2: Brightness per Channel
This example influences the brightness of each channel individually. This subtracts 0.2 from the red channel, adds 0.314 to the green channel, and adds 0.75 to the blue channel, while keeping Alpha as it is.
Example 3: Copying Values

You can also copy color values back and forth between individual channels. In this example, the red channel contains the luminance values of the image based on thirds, and the green channel contains the luminance values based on the proper black-and-white conversion method, whereas the blue channel uses a third method based on getting more information from red and less from blue. The blue channel's brightness is also lowered by 0.1, and the Alpha channel is replaced with the original blue channel.

Settings Tab

The Settings tab in the Inspector is also duplicated in other Color nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Color Space [CS]

Color Space Node Introduction

The Color Space node provides the ability to work on an image in a variety of alternate color space formats. By default, Fusion uses the RGB color space, and most nodes and displays interpret the primary channels of an image as Red, Green, and Blue.

Changing the color space from RGB causes most images to look odd, as Fusion’s viewers still interpret the primary channels as Red, Green, and Blue. For example, viewing an image converted to YUV in one of the viewers shows the Y channel as Red, the U channel as Green, and the V channel as Blue.

Several common elements of the Fusion interface refer to the RGB channels directly. The four buttons commonly found on the Inspector’s Settings tab to restrict the effect of the node to a single color channel are one example. When a conversion is applied to an image, the labels of these buttons remain R, G, and B, but the values they represent are from the current color space. (For example, Red is Hue, Green is Luminance, and Blue is Saturation for an RGB to HLS conversion. The Alpha value is never changed by the color space conversion.)
**Inputs**

The Color Space node includes two inputs: one for the main image and the other for an effect mask.

- **Input:** This orange input is the only required connection. It connects a 2D image that is converted by the color space operation.

- **Effect Mask:** The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the color space adjustment to only those pixels within the mask. An effect mask is applied to the tool after it is processed.

**Basic Node Setup**

The Color Space node, like many 2D image-processing nodes, receives a 2D image like a Loader or the MediaIn1 shown below, processes the image, and then extends the node tree by connecting to another 2D image-processing node or a Merge node.

![A Color Space node applies a conversion to a MediaIn1 node](image)

**Inspector**

The Color Space node consists of two menus. The top Conversion menu determines whether you are converting an image to RGB or from RGB. The bottom menu selects the alternative color space you are either converting to or from.

**Conversion**

This menu has three options. The None option has no effect on the image. When To Color is selected, the input image is converted to the color space selected in the Color Type control found below. When To RGB is selected, the input image is converted back to the RGB color space from the type selected in the Color Type menu (for example, YUV to RGB).

**Color Type**

This menu is used to select the color space conversion applied when the To Color conversion is selected. When the To RGB option is selected in the Conversion menu, the Color Type option should reflect the input image’s current color space. There are eight color space options to choose from.

- **HSV (Hue, Saturation, and Value):** Each pixel in the HSV color space is described in terms of its Hue, Saturation, and Value components. Value is defined as the quality by which we distinguish a light color from a dark one or brightness. Decreasing saturation roughly corresponds to adding white to a paint chip on a palette. Increasing Value is roughly similar to adding black.
– **YUV (Luma, Blue Chroma, and Red Chroma):** The YUV color space is used in the analog broadcast of PAL video. Historically, this format was often used to color correct images because of its familiarity to a large percentage of video engineers. Each pixel is described in terms of its Luminance, Blue Chroma, and Red Chroma components.

– **YIQ (Luma, In Phase, and Quadrature):** The YIQ color space is used in the analog broadcast of NTSC video. This format is much rarer than YUV and almost never seen in production. Each pixel is described in terms of its Luminance, Chroma (in-phase or red-cyan channel), and Quadrature (magenta-green) components.

– **CMY (Cyan, Magenta, and Yellow):** Although more common in print, the CMY format is often found in computer graphics from other software packages. Each pixel is described in terms of its Cyan, Magenta, and Yellow components. CMY is nonlinear.

– **HLS (Hue, Luminance, and Saturation):** Each pixel in the HLS color space is described in terms of its Hue, Luminance, and Saturation components. The differences between HLS and HSV color spaces are minor.

– **XYZ (CIE Format):** This mode is used to convert a CIE XYZ image to and from RGB color spaces. CIE XYZ is a weighted space, instead of a nonlinear one, unlike the other available color spaces. Nonlinear in this context means that equal changes in value at different positions in the color space may not necessarily produce the same magnitude of change visually to the eye.

Expressed simply, the CIE color space is a perceptual color system, with weighted values obtained from experiments where subjects were asked to match an existing light source using three primary light sources.

This color space is most often used to perform gamut conversion and color space matching between image display formats because it contains the entire gamut of perceivable colors.

– **Negative:** The color channels are inverted. The color space remains RGBA.

– **BW:** The image is converted to black and white. The contribution of each channel to the luminance of the image is adjustable via slider controls that appear when this option is selected. The default values of these sliders represent the usual perceptual contribution of each channel to an image’s luminance. The color space of the image remains RGBA.

### Settings Tab

The Settings tab in the Inspector is also duplicated in other Color nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

### Copy Aux [CPA]

The Copy Aux node

### Copy Aux Node Introduction

The Copy Aux node is used to shuffle channels between visible channels and auxiliary data channels in a single 2D image. Typically, these auxiliary channels are rendered from 3D applications. Auxiliary channels supported in the Copy Aux node include background color, z-depth, texture coordinates, coverage, object ID, material ID, normals, vectors, back vectors, and world position.
The Copy Aux node is mostly a convenience node, as the copying can also be accomplished with more effort using a Channel Booleans node. Where Channel Booleans deals with individual channels, Copy Aux deals with channel groups. By default, the Copy Aux node automatically promotes the depth of its output to match the depth of the aux channel.

Copy Aux also supports static normalization ranges. The advantage of static normalization versus the dynamic normalization that Fusion’s viewers do is that colors remain constant over time. For example, if you are viewing Z or WorldPos values for a ball, you see a smooth gradient from white to black. Now imagine that some other 3D object is introduced into the background at a certain time. Dynamic normalization turns the ball almost completely white while the background object is now the new black. Dynamic normalization also causes flicker problems while viewing vector/disparity channels, which can make it difficult to compare the aux channels of two frames at different times visually.

**Inputs**

The Copy Aux node includes two inputs: one for the main image and the other for an effect mask.

- **Input:** This orange input is the only required connection. It connects a 2D image for the Copy Aux node operation.
- **Effect Mask:** The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the Copy Aux operation to only those pixels within the mask. An effect mask is applied to the tool after the tool is processed.

**Basic Node Setup**

The Copy Aux node, like many 2D image-processing nodes, receives a 2D image like a Loader node or the MediaIn1 shown below. The output continues the node tree by connecting to another 2D image-processing node or a Merge node.

![A Copy Aux node applied to a MediaIn1 node](Image)

**Inspector**

Copy Aux controls
Controls Tab
The Controls tab is used to copy auxiliary channel groups into RGBA channels. Although Copy Aux has quite a few options, most of the time you select only the channel to copy and ignore the remaining functionality.

Mode
The Mode menu determines whether the auxiliary channel is copied into the RGBA color channel (Aux to Color) or vice versa (Color to Aux). Using this option, you can use one Copy Aux node to bring an auxiliary channel into color, do some compositing operations on it, and then use another Copy Aux node to write the color back into the auxiliary channel. When the Mode is set to Color to Aux, all the options in the Controls tab except the Aux Channel menu are hidden.

Aux Channel
The Aux Channel menu selects the auxiliary channel to be copied from or written to depending on the current mode. When the aux channel abcd has one valid component, it is copied as aaa1, two valid components as ab01, three valid components as abc1, and four components as abcd. For example, the Z-channel is copied as zzz1, texture coordinates as uv01, and normals as nxynzn1.

Out Color Depth
Out Color Depth controls the color depth of the output image. Most aux channels contain float values or, if they are integer valued, they can contain values beyond 255. When you copy float values into an int8 or int16 image, this can be a problem since negative values and values over 1.0 can get clipped. In addition, precision can be lost. This option determines what happens if the depth of RGBA channels of the input image is insufficient to contain the copied aux channel.

Be careful when copying float channels into integer image formats, as they can get clipped if you do not set up Copy Aux correctly. For this node, all aux channels are considered to be float32 except ObjectID or MaterialID, which are considered to be int16.

– Match Aux Channel Depth: The bit depth of the RGBA channels of the output image is increased to match the depth of the aux channel. Specifically, this means that the RGBA channels of the output image are either int16 or float32. Be careful when using this option because, for example, if you normally have int8 color channels, you are now using 2x or 4x more memory for the color channels. Particularly, the Z, Coverage, TextureCoordinate, Normal, Vector, BackVector, WorldPosition, and Disparity channels are always output as float, and the Material/ObjectID channels are output as int16.

– Match Source Color Depth: The bit depth of the RGBA channels of the output image is the same as the input image. This can have some unexpected consequences. For example, if your input image is int8, the XYZ components of normals that are floating-point numbers in the [-1, 1] range are clipped to non-negative numbers [0, 1] range. As a more extreme example, consider what happens to Z values. Z values are floating-point numbers stored in the [-1e30, 0] range, and they all get truncated to the [0, 1] range, which means your Z-channel is full of zeroes.

– Force Float32: The bit depth of the RGBA channels of the output image is always float32.

Channel Missing
Channel Missing determines what happens if a channel is not present. For example, this determines what happens if you chose to copy Disparity to Color and your input image does not have a Disparity aux channel.

– Fail: The node fails and prints an error message to the console.
– Use Default Value: This fills the RGBA channels with the default value of zero for everything except Z, which is -1e30.
**Kill Aux Channels**

When this is checked, Copy Aux copies the requested channel to RGBA and then outputs a resulting image that is purely RGBA with other channels being killed. This is useful if you want to increase the number of frames of Copy Aux that can be cached for playback—for example, to playback a long sequence of disparity. A handy tip is that you can use the Kill Aux feature also with just Color to Aux > Color for a longer color playback.

![Kill Aux channels](image)

**Enable Remapping**

When remapping is enabled, the currently selected aux channel is rescaled, linearly mapping the range according to the From and To slider selections as explained below. The Remapping options are applied before the conversion operation. This means you could set the From > Min-Max values to -1, 1 to rescale your normals into the [0, 1] range, or set them to [-1000, 0] to rescale your Z values from [-1000, 0] into the [0, 1] range before the clipping occurs.

Note that the Remapping options are per channel options. That means the default scale for normals can be set to [-1, +1] > [0, 1] and for Z it can be set [-1000, 0] > [0, 1]. When you flip between normals and Z, both options are remembered. One way this could be useful is that you can set up the remapping ranges and save this as a setting that you can reuse. The remapping can be useful to squash the aux channels into a static [0, 1] range for viewing or, for example, if you wish to compress normals into the [0, 1] range to store them in an int8 image.

- **From > Min**: This is the value of the aux channel that corresponds to To > Min.
- **From > Max**: This is the value of the aux channel that corresponds to To > Max. It is possible to set the max value less than the min value to achieve a flip/inversion of the values.
- **Detect Range**: This scans the current image to detect the min/max values and then sets the From > Min/From > Max Value controls to these values.
- **Update Range**: This scans the current image to detect the min/max values and then enlarges the current [From > Min, From > Max] region so that it contains the min/max values from the scan.
- **To > Min**: This is the minimum output value, which defaults to 0.
- **To > Max**: This is the maximum output value, which defaults to 1.
- **Invert**: After the values have been rescaled into the [To > Min, To > Max] range, this inverts/flips the range.

**Settings Tab**

The Settings tab in the Inspector is also duplicated in other Color nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
Gamut [GMT]

The Gamut node

Gamut Node Introduction

The Gamut node has controls to transform one color space to another and remove/add gamma curves. This node, along with the Cineon Log node, is primarily used to linearize incoming images and then reapply the applicable output gamma curve at the end of a node tree.

Inputs

The Gamut node includes two inputs: one for the main image and the other for an effect mask to limit the conversion area.

- **Input:** This orange input is the only required connection. It connects a 2D image output that is the source of the gamut conversion.
- **Effect Mask:** The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the Gamut operation to only those pixels within the mask. An effect mask is applied to the tool after the tool is processed.

Basic Node Setup

A Gamut node is most often placed directly after the MediaIn node in DaVinci Resolve or a Loader node in Fusion Studio. Another Gamut node is usually placed at the end of a node tree before a MediaOut node in DaVinci Resolve or a Saver node in Fusion Studio.

Inspector

A Gamut node applied to a MediaIn node
Gamut controls

Controls Tab
The Controls tab is where all the conversion operations take place. It has a section for incoming images and a section for the node’s output. Which section you use depends on whether you are stripping an image of a gamma curve to make it linear or converting a linear image to a specific color space and gamma curve for output.

Source Space
Source Space determines the input color space of the image. When placed directly after a Loader node in Fusion or a MediaIn node in DaVinci Resolve, you would select the applicable color space based on how the image was created and check the Remove Gamma checkbox. The output of the node would be a linearized image. You leave this setting at No Change when you are adding gamma using the Output Space control and placing the node directly before the Saver node in Fusion or a MediaOut node in DaVinci Resolve.

DCI-P3
The DCI-P3 color space is most commonly used in association with DLP projectors. It is frequently provided as a color space available with DLP projectors and as an emulation mode for 10-bit LCD monitors such as the HP Dreamcolor and Apple’s Pro Display XDR. This color space is defined in the SMPTE-431-2 standard.

Custom
The Custom gamut allows you to describe the color space according to CIE 1931 primaries and white point, which are expressed as XY coordinates, as well as by gamma, limit, and slope. For example, the DCI-P3 gamut mentioned above would have the following values if described as a Custom color space.

<table>
<thead>
<tr>
<th></th>
<th>X</th>
<th>Y</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red Primary</td>
<td>0.68</td>
<td>0.32</td>
</tr>
<tr>
<td>Green Primary</td>
<td>0.265</td>
<td>0.69</td>
</tr>
<tr>
<td>Blue Primary</td>
<td>0.15</td>
<td>0.06</td>
</tr>
<tr>
<td>White Point</td>
<td>0.314</td>
<td>0.351</td>
</tr>
<tr>
<td>Gamma</td>
<td>2.6</td>
<td>–</td>
</tr>
<tr>
<td>Linear Limit</td>
<td>0.0313</td>
<td>–</td>
</tr>
</tbody>
</table>

To understand how these controls work, you could view the node attached to a gradient background in Waveform mode and observe how different adjustments modify the output.
**Output Space**
Output Space converts the gamut to the desired color space. For instance, when working with linearized images in a composite, you place the Gamut node just before the Saver node and use the Output Space to convert to the gamut of your final output file. You leave this setting at No Change when you want to remove gamma using the Source Space control.

**NOTE:** When outputting to HD specification Rec. 709, Fusion uses the term Scene to refer to a gamma of 2.4 and the term Display for a gamma of 2.2.

**Remove/Add Gamma**
Select these checkboxes to do the gamut conversion in a linear or nonlinear gamma, or simply remove or add the applicable gamma values without changing the color space.

**Pre-Divide/Post-Multiply**
Selecting this checkbox causes the image’s pixel values to be divided by the Alpha values prior to the color correction, and then re-multiplied by the Alpha value after the correction. This helps to avoid the creation of illegally additive images, particularly around the edges of a blue/green key or when working with 3D-rendered objects.

**Settings Tab**
The Settings tab in the Inspector is also duplicated in other Color nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

**Hue Curves [HCV]**

![Hue Curves node](image)

**Hue Curves Node Introduction**
The Hue Curves node allows you to adjust the color in an image using a series of spline curves. Splines are provided to control the image’s hue, saturation, and luminance as well as each individual color channel. An additional set of curves allows you to apply suppression to individual color channels.

The advantage of the Hue Curves node over other color correction nodes in Fusion is that the splines can be manipulated to restrict the node’s effect to a very narrow portion of the image, or expanded to include a wide-ranging portion of the image. Additionally, these curves can be animated to follow changes in the image over time. Since the primary axis of the spline is defined by the image’s hue, it is much easier to isolate a specific color from the image for adjustment.
Inputs
The Hue Curves node includes two inputs: one for the main image and the other for an effect mask to limit the color correction area.

- **Input:** This orange input is the only required connection. It connects a 2D image for the Hue Curves color correction.
- **Effect Mask:** The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the Hue Curves operation to only those pixels within the mask. An effect mask is applied to the tool after it is processed.

Basic Node Setup
The Hue Curves node, like many 2D image-processing nodes, receives a 2D image like a Loader node or the MediaIn1 shown below. The output continues the node tree by connecting to another 2D image-processing node or a Merge node.

Inspector
Controls Tab
The Controls tab consists of color attribute checkboxes that determine which splines are displayed in the Spline window. The spline graph runs horizontally across with control points placed horizontally at each of the primary colors. You can manipulate these control points to change the selected color attribute.
**Mode**

The Mode options change between No Animation and Animated Points modes. The default mode is No Animation, where adjustments to the curves are applied consistently over time. Setting the Mode to Animated Points or Dissolve allows the color curve to be animated over time.

Dissolve mode is essentially obsolete and is included for compatibility reasons only.

**Color Channel Checkboxes**

These checkboxes define which splines are editable and are included when using the Eyedropper to pick a color in the image.

Any number of activated splines can be edited simultaneously; however it’s more convenient to have only the currently modified spline active to avoid unwanted changes to other splines.

When using the Eyedropper icon, a point is created on all active splines, representing the selected color.

**Spline Window**

This graph display is the main interface element of the Hue Curves node, which hosts the various splines. In appearance, the node is very similar to the Color Curves node, but here the horizontal axis represents the image’s hue, while the vertical axis represents the degree of adjustment. The Spline window shows the curves for the individual channels. It is a miniature Spline Editor. In fact, the curves shown in this window can also be found and edited in the Spline Editor.

The spline curves for all components are initially flat, with control points placed horizontally at each of the primary colors. From left to right, these are: Red, Yellow, Green, Cyan, Blue, and Magenta. Because of the cyclical design of the hue gradient, the leftmost control point in each curve is connected to the rightmost control point of the curve.

Right-clicking in the graph displays a contextual menu containing options for resetting the curves, importing external curves, adjusting the smoothness of the selected control points, and more.

**In and Out**

Use the In and Out controls to manipulate the precise values of a selected point. To change a value, select a point and enter the In/Out values desired.

**Eyedropper**

Left-clicking and dragging from the Eyedropper icon changes the current mouse cursor to an Eyedropper. While still holding down the mouse button, drag the cursor to a viewer to pick a pixel from a displayed image. This causes control points, which are locked on the horizontal axis, to appear on the currently active curves. The control points represent the position of the selected color on the curve. Use the contextual menu’s Lock Selected Points toggle to unlock points and restore the option of horizontal movement.

Points are only added to enabled splines. To add points only on a specific channel, disable the other channels before making the selection.

**Pre-Divide/Post-Multiply**

Selecting this checkbox causes the image’s pixel values to be divided by the Alpha values prior to the color correction, and then re-multiplied by the Alpha value after the correction. This helps when color correcting images that include a premultiplied Alpha channel.

**Settings Tab**

The Settings tab in the Inspector is also duplicated in other Color nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
OCIO CDL Transform Node Introduction

Fusion supports the Open Color IO color management workflow by way of three OCIO nodes.

- The OCIO CDL Transform node allows you to create, save, load, and apply a Color Decision List (CDL) grade.
- The OCIO Color Space allows sophisticated color space conversions, based on an OCIO config file.
- The OCIO File Transform allows you to load and apply a variety of Lookup tables (LUTs).

Generally, the OCIO color pipeline is composed from a set of color transformations defined by OCIO-specific config files, commonly named with a ".ocio" extension. These config files allow you to share color settings within or between facilities. The path to the config file to be used is normally specified by a user-created environment variable called "OCIO," although some tools allow overriding this. If no other *.ocio config files are located, the DefaultConfig.ocio file in Fusion’s LUTs directory is used.

For in-depth documentation of the format’s internals, please refer to the official pages on opencolorio.org.

Inputs

The OCIO CDL Transform node includes two inputs: one for the main image and the other for an effect mask to limit the area where the CDL is applied.

- **Input:** This orange input is the only required connection. It connects a 2D image output for the CDL grade.
- **Effect Mask:** The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the CDL grade to only those pixels within the mask. An effect mask is applied to the tool after it is processed.

Basic Node Setup

The OCIO CDL Transform node is often applied after a Gamut node converts the Loader to linear color in Fusion Studio.

A OCIO CDL Transform node applied to a Loader node after a Gamut conversion to linear in Fusion Studio.
Inspector

OCIO Transform controls

Controls Tab
The Controls tab for the OCIO CDL Transform contains primary color grading color correction controls in a format compatible with CDLs. You can make R, G, B adjustments based on the Slope, Offset, and Power. There is also overall Saturation control. You can also use the Controls tab to import and export the CDL compatible adjustments.

Operation
This menu switches between File and Controls. In File mode, standard ASC-CDL files can be loaded. In Controls mode, manual adjustments can be made to Slope, Offset, Power, and Saturation, and the CDL file can be saved.

NOTE: Using DaVinci Resolve terminology, slope is similar to gain. It controls mids-to-high contrast. Offset is the overall offset of color balance and exposure. Power is very similar to contrast with a raised pivot, giving you control over shadow contrast.
**Direction**

Toggles between Forward and Reverse. Forward applies the corrections specified in the node, while Reverse tries to remove those corrections. Keep in mind that not every color correction can be undone.

Imagine that all slope values have been set to 0.0, resulting in a fully black image. Reversing that operation is not possible, neither mathematically nor visually.

**Slope**

![Slope Graphs]

Slope multiplies the color values; this is the same as Gain in the Brightness Contrast node.

**Offset**

![Offset Graphs]

Offset adds to the color values; this is the same as Brightness in the Brightness Contrast node.

**Power**

Applies a Gamma Curve. This is an inverse of the Gamma function of the Brightness Contrast node.

**Saturation**

Enhances or decreases the color saturation. This works the same as Saturation in the Brightness Contrast node.

**Export File**

Allows the user to export the settings as a CDL file.

**Settings Tab**

The Settings tab in the Inspector is also duplicated in other Color nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
OCIO Color Space Node Introduction

Fusion supports the Open Color IO color management workflow by way of three OCIO nodes.

- The OCIO CDL Transform node allows you to create, save, load, and apply a Color Decision List (CDL) grade.
- The OCIO Color Space allows sophisticated color space conversions, based on an OCIO config file.
- The OCIO File Transform allows you to load and apply a variety of Lookup tables (LUTs).

Generally, the OCIO color pipeline is composed from a set of color transformations defined by OCIO-specific config files, commonly named with a ".ocio" extension. These config files allow you to share color settings within or between facilities. The path to the config file to be used is normally specified by a user-created environment variable called "OCIO," though some tools allow overriding this. If no other *.ocio config files are located, the DefaultConfig.ocio file in Fusion's LUTs directory is used.

For in-depth documentation of the format's internals, please refer to the official pages on opencolorio.org.

Sample configs can be obtained from opencolorio.org/downloads.html

The functionality of the OCIO Color Space node is also available as a View LUT node from the View LUT menu.

Inputs

The OCIO Color Space node includes two inputs: one for the main image and the other for an effect mask to limit the area where the color space conversion is applied.

- **Input**: This orange input is the only required connection. It connects a 2D image for the color space conversion.

- **Effect Mask**: The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the color space conversion to only those pixels within the mask. An effect mask is applied to the tool after it is processed.

Basic Node Setup

The OCIO Color Space node is typically placed directly after a MediaIn node in DaVinci Resolve or a Loader node in Fusion Studio. Another OCIO Color Space node is placed just before a Media Out node in DaVinci Resolve or a Saver node in Fusion Studio.
An OCIO Color Space node applied to a Loader node and a Saver node in Fusion Studio

## Inspector

![OCIO Color Space controls](image)

### Controls Tab

The Controls tab for the OCIO Color Space node allows you to convert an image from one color space to another based on an OCIO config file. By default, it uses the config file included with Fusion; however, the Controls tab does allow you to load your own config file as well.

#### OCIO Config

Displays a File > Open dialog to load the desired config file.

#### Source Space

Based on the config file, the available source color spaces are listed here.

The content of this list is based solely on the loaded profile and hence can vary immensely. If no other OCIO config file is loaded, the DefaultConfig.ocio file in Fusion’s LUTs directory is used to populate this menu.

#### Output Space

Based on the config file, the available output color spaces are listed here.

The content of this list is based solely on the loaded profile and hence can vary immensely. If no other OCIO config file is loaded, the DefaultConfig.ocio file in Fusion’s LUTs directory is used to populate this menu.

#### Look

Installed OCIO Color Transform Looks appear in this menu. If no looks are installed, this menu has only None listed as an option.

### Settings Tab

The Settings tab in the Inspector is also duplicated in other Color nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
OCIO File Transform Node Introduction

Fusion supports the Open Color IO color management workflow by way of three OCIO nodes.

- The OCIO CDL Transform node allows you to create, save, load, and apply a Color Decision List (CDL) grade.
- The OCIO Color Space allows sophisticated color space conversions, based on an OCIO config file.
- The OCIO File Transform allows you to load and apply a variety of Lookup tables (LUTs).

Generally, the OCIO color pipeline is composed from a set of color transformations defined by OCIO-specific config files, commonly named with a ".ocio" extension. These config files allow you to share color settings within or between facilities. The path to the config file to be used is normally specified by a user-created environment variable called "OCIO," though some tools allow overriding this. If no other *.ocio config files are located, the DefaultConfig.ocio file in Fusion’s LUTs directory is used.

For in-depth documentation of the format’s internals, please refer to the official pages on opencolorio.org.

The functionality of the OCIO File Transform node is also available as a View LUT node from the View LUT menu.

Inputs

The OCIO File Transform node includes two inputs: one for the main image and the other for an effect mask to limit the area where the color space conversion is applied.

- Input: This orange input is the only required connection. It connects a 2D image for the LUT.
- Effect Mask: The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the applied LUT to only those pixels within the mask. An effect mask is applied to the tool after it is processed.

Basic Node Setup

The OCIO File Transform node is often applied after a Gamut node converts the Loader to linear color in Fusion Studio.
Inspector

Controls Tab
The Controls tab for the OCIO File Transform node includes options to import the LUT, invert the transform, and select the color interpolation method.

LUT File
Displays a File > Open dialog to load the desired LUT.

CCC ID
This is the ID key used to identify the specific file transform located within the ASC CDL color correction XML file.

Direction
Toggles between Forward and Reverse. Forward applies the corrections specified in the node, while Reverse tries to remove those corrections. Keep in mind that not every color correction can be undone. Imagine that all slope values have been set to 0.0, resulting in a fully black image. Reversing that operation is not possible, neither mathematically nor visually.

Interpolation
Allows the user to select the color interpolation to achieve the best quality/render time ratio. Nearest is the fastest interpolation, while Best is the slowest.

Settings Tab
The Settings tab in the Inspector is also duplicated in other Color nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Set Canvas Color [SCV]

Set Canvas Color Node Introduction
Set Canvas Color is used to set the color of the area outside the domain of definition (DoD). This is the workspace area beyond the raster by default, which is invisible since outside the raster is not
rendered. However, the DoD can be within the raster as well. This can occur when compositing images smaller than the raster, or with transforms. By default, the canvas color used is black/no Alpha (transparent). However, since some nodes may change an image’s canvas color—for example, inverting a mask changes the mask’s canvas from black to white—the Set Canvas Color allows you to control the color of the canvas to whatever you require.

The Set Canvas Color node sets the color of the workspace outside the domain of definition (DOD). For example, if you create a circular gradient, the DoD is a square around the circular gradient in the viewer. Everything outside the DoD is understood to be black and therefore does not have to be rendered. To change the area outside the DoD, attach the Set Canvas Color node after the background and change the color.

NOTE: Position the mouse pointer in a black area outside the raster to view the RGB canvas color in the status bar at the bottom left of the Fusion window.

Inputs

The Set Canvas Color node includes two inputs: one for the main image and a second for a foreground.

- **Input**: This orange input is the only required connection. It accepts a 2D image that reveals the canvas color if the image’s DoD is smaller than the raster.
- **Foreground**: The optional green foreground input allows the canvas color to be sampled from an image connected to this input.

Basic Node Setup

The Set Canvas Color node is placed after the image is transformed to reveal part of the raster outside the domain of definition.

![A Set Canvas Color node applied to a transformed MediaIn node](image)

The Set Canvas Color node is often used for adjusting keys. In the example above, the Luma Keyer is extracting a key, and therefore assigns the area outside the DoD, which is black, as an opaque foreground. If the element is scaled down and composited, you do not see the background. To correct this, insert a SetBGColor before the keyed element is placed in the composite. For example, LumaKey > Set Canvas Color > Transform > Merge.
Inspector

Controls Tab
The Controls tab for the Set Canvas Color is used for simple color selection. When the green foreground is connected, the tab is empty.

Color Picker
Use these controls to adjust the Color and the Alpha value for the image’s canvas. It defaults to black with zero Alpha.

Settings Tab
The Settings tab in the Inspector is also duplicated in other Color nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

White Balance [WB]

White Balance Node Introduction
The White Balance node can be used to automatically remove color casts in the image caused by the incorrect setup of a camera or bad lighting conditions.

Correction can be done by selecting a color temperature or by choosing a neutral color from the original image that exhibits the color cast to be corrected.

IMPORTANT
When picking neutral colors using the Custom method, make sure you are picking from the source image, not the results of the White Balance node. This ensures that the image doesn’t change while you are still picking, and that the White Balance node gets an accurate idea of the original colors it needs to correct.
**Inputs**

The White Balance node includes two inputs: one for the main image and the other for an effect mask to limit the area where the white balance is applied.

- **Input:** This orange input is the only required connection. It connects a 2D image for the white balance.
- **Effect Mask:** The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the white balance to only those pixels within the mask. An effect mask is applied to the tool after it is processed.

**Basic Node Setup**

The White Balance node, like many 2D image-processing nodes, receives a 2D image like the MediaIn1 shown below. The output continues the node tree by connecting to another 2D image-processing node or a Merge node.

![A White Balance node applied to a MediaIn1 node](image)

**Inspector**

![White Balance controls](image)
Balance Tab

Space
Use this menu to select the color space of the source image, if it is known. This can make the correction more accurate since the node can take the natural gamma of the color space into account as part of the correction. If the color space that the image uses is unknown, leave this menu at its default value.

Method
The White Balance node can operate using one of two methods: a Custom method or a color Temperature method.

– **Custom**: The Custom method requires the selection of a pixel from the scene that should have been pure gray. The node uses this information to calculate the color correction required to convert the pixel so that it actually is gray. When the correction is applied without an effect mask connected and the LockBlack/Mid/White checkbox enabled, the node white balances the entire shot.

– **Temperature**: The color Temperature method requires that the actual color temperature of the shot be specified.

Lock Black/Mid/White
This checkbox locks the Black, Midtones, and White points together so that the entire image is affected equally. Unchecking the control provides individual controls for white balancing each range separately. This control affects both methods equally.

Black/Mid/White Reference
These controls appear only if the Custom method is selected. They are used to select a color from a pixel in the source image. The White Balance node color corrects the image so that the selected color is transformed to the color set in the Result Color Picker below. Generally, this is gray. A color that is supposed to be pure gray but is not truly gray for one reason or another should be selected.

If the Lock Black/Mid/White checkbox is deselected, different references can be selected for each color range.

For example, try to select a pixel for the black and white references that are not clipped in any of the color channels. In the high end, an example would be a pixel that is light pink with values of 255, 240, 240. The pixel is saturated/clipped in the red, although the color is not white. Similarly, a really dark blue-gray pixel might be 0, 2, 10. It is clipped in red as well, although it is not black.

Neither example would be a good choice as a reference pixel because there would not be enough headroom left for the White Balance node.

Black/Mid/White Result
These controls appear only if the Custom method is selected. They are used to select the color that the node uses to balance the reference color. This generally defaults to pure, midrange gray.

If the Lock Black/Mid/White checkbox is deselected, different results can be selected for each color range.
White Balance Temperature controls

Temperature Reference
When the Method menu is set to Temperature, the Temperature reference control is used to set the color temperature of the source image. If the Lock Black/Mid/White checkbox is deselected, different references can be selected for each color range.

Temperature Result
Use this control to set the target color temperature for the image. If the Lock Black/Mid/White checkbox is deselected, different results can be selected for each color range.

Use Gamma
This checkbox selects whether the node takes the gamma of the image into account when applying the correction, using the default gamma of the color space selected in the Space menu at the top of the tab.

Ranges Tab
The Ranges tab can be used to customize the range of pixels in the image considered to be shadows, midtones, and highlights by the node.

Spline Display
The ranges are selected by manipulating the spline handles. There are four spline points, each with one Bézier handle. The two handles at the top represent the start of the shadow and highlight ranges, whereas the two at the bottom represent the end of the range. The Bézier handles are used to control the falloff.

The midtones range has no specific controls since its range is understood to be the space between the shadow and the highlight ranges.

The X and Y text controls below the Spline display can be used to enter precise positions for the selected Bézier point or handle.
**Preset Simple/Smooth Ranges**

These two buttons can be used to return the spline ranges to either Smooth (default) or Simple (linear) settings.

**Settings Tab**

The Settings tab in the Inspector is also duplicated in other Color nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

**The Common Controls**

Nodes that handle Color adjustment operations share several identical controls in the Inspector. This section describes controls that are common among color nodes.

**Inspector**

![Color Settings Inspector]

**Settings Tab**

The Settings tab in the Inspector can be found on every tool in the Color category. The Settings controls are even found on third-party color type plug-in tools. The controls are consistent and work the same way for each tool, although some tools do include one or two individual options that are also covered here.
**Blend**

The Blend control is used to blend between the tool's original image input and the tool's final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming image. Normally, this causes the tool to skip processing entirely, copying the input straight to the output.

**Process When Blend Is 0.0**

The tool is processed even when the input value is zero. This can be useful if processing of this node is scripted to trigger another task, but the value of the node is set to 0.0.

**Red/Green/Blue/Alpha Channel Selector**

These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.

For example, if the red button on a blur tool is deselected, the blur is first applied to the image, and then the red channel from the original input is copied back over the red channel of the result.

There are some exceptions, such as tools for which deselecting these channels causes the tool to skip processing that channel entirely. Tools that do this generally possess a set of identical RGBA buttons on the Controls tab in the tool. In this case, the buttons in the Settings and the Controls tabs are identical.

**Apply Mask Inverted**

Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

**Multiply by Mask**

Selecting this option causes the RGB values of the masked image to be multiplied by the mask channel's values. This causes all pixels not included in the mask (i.e., set to 0) to become black/transparent.

**Use Object/Use Material (Checkboxes)**

Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports Object and Material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels are used, if present. The specific Material ID or Object ID affected is chosen using the next set of controls.

**Correct Edges**

This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information on Coverage and Background Color channels, see Chapter 18, "Understanding Image Channels" in the Fusion Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.

**Object ID/Material ID (Sliders)**

Use these sliders to select which ID is used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker: to grab IDs from the image displayed in the viewer. The image or sequence must have been rendered from a 3D software package with those channels included.
**Clipping Mode**

This option determines how edges are handled when performing domain of definition rendering. This is mostly important for nodes like Blur, which may require samples from portions of the image outside the current domain.

- **Frame:** The default option is Frame, which automatically sets the node’s domain of definition to use the full frame of the image, effectively ignoring the current domain of definition. If the upstream DoD is smaller than the frame, the remaining area in the frame is treated as black/transparent.

- **Domain:** Setting this option to Domain respects the upstream domain of definition when applying the node’s effect. This can have adverse clipping effects in situations where the node employs a large filter.

- **None:** Setting this option to None does not perform any source image clipping at all. This means that any data required to process the node’s effect that would normally be outside the upstream DoD is treated as black/transparent.

**Use GPU**

The Use GPU menu has three settings. Setting the menu to Disable turns off hardware-accelerated rendering using the graphics card in your computer. Enabled uses the hardware. Auto uses a capable GPU if one is available and falls back to software rendering when a capable GPU is not available.

**Motion Blur**

- **Motion Blur:** This toggles the rendering of Motion Blur on the tool. When this control is toggled on, the tool’s predicted motion is used to produce the motion blur caused by the virtual camera’s shutter. When the control is toggled off, no motion blur is created.

- **Quality:** Quality determines the number of samples used to create the blur. A quality setting of 2 causes Fusion to create two samples to either side of an object’s actual motion. Larger values produce smoother results but increase the render time.

- **Shutter Angle:** Shutter Angle controls the angle of the virtual shutter used to produce the motion blur effect. Larger angles create more blur but increase the render times. A value of 360 is the equivalent of having the shutter open for one whole frame exposure. Higher values are possible and can be used to create interesting effects.

- **Center Bias:** Center Bias modifies the position of the center of the motion blur. This allows the creation of motion trail effects.

- **Sample Spread:** Adjusting this control modifies the weighting given to each sample. This affects the brightness of the samples.

**Comments**

The Comments field is used to add notes to a tool. Click in the field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

**Scripts**

Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
Chapter 96

Composite Nodes

This chapter details the Dissolve and Merge nodes available in Fusion.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

Dissolve [DX] 1873
Merge [MRG] 1875
The Common Controls 1883
Dissolve [DX]

The Dissolve node

Dissolve Node Introduction

The Dissolve node is typically used to mix two images together, providing a gradual transition between two clips. A Background/Foreground slider controls the mix between the foreground and background images. Dissolves are commonly used to transition between one clip and another and are a very common effect in editing. However, you can also use the extreme left and right positions of the Background/Foreground slider to switch between inputs. Unlike other nodes in Fusion, the Dissolve node does not require you to connect an image to the background but lets you output either the background or foreground according to the setting of the Background/Foreground slider.

This quality makes it possible for you use the Dissolve node as an automatic layer switching tool when connected to background and foreground clips with different durations. Simply connect each clip to the background and foreground inputs, respectively, and set the Background/Foreground slider to the input of shorter duration, to determine which is “on top.” After the last frame of that clip has ended, the Dissolve node automatically switches to the clip that’s connected to the other input.

Besides the default dissolve, the Gradient Wipe setting of the Operation menu allows you to create arbitrary animated dissolve patterns based on the luminance of an image connected to the optional Gradient Wipe input. You can use this capability with images of geometric shapes or gradients of different kinds, movie clips of fire, water ripples, or rain, the Fast Noise node, or even particle systems you create within the Fusion page to create a variety of unique and creative transitions. Soft-edged effect masks may also be used to add to the possible effects.

Ultimately, animating the Background/Foreground control allows you to control the transition that’s being used to switch from the foreground input to the background, or vice versa.

Inputs

The Dissolve node provides three image inputs, all of which are optional:

- **Background**: The first of two images you want to switch between or mix. Unlike most other nodes, it is unnecessary to connect the background input before connecting the foreground input.

- **Foreground**: The second of two images you want to switch between or mix. The Dissolve node works best when both foreground and background inputs are connected to images with the same resolution.

- **Gradient Map**: (Optional) The Gradient Map is required only when Gradient Wipe is selected.

Basic Node Setup

Dissolve nodes are typically connected in the following way, with two input images connected to the background and foreground inputs, and the output connected to the next node in the composition.
A typical dissolve node structure in Fusion

Resolution Handling

It is recommended to make sure that all images connected to the foreground, background, and gradient map inputs of the Dissolve node have the same resolution and the same pixel aspect. This is not required, however. But, the result if you mix resolutions depends on how you set the Background/Foreground slider.

- If the input images are different sizes, but the Foreground/Background slider is set to full Foreground (all the way to the right) or full Background (all the way to the left), then the output resolution will be identical to the image resolution of the corresponding node input.

- If input images of different sizes are mixed by setting the Background/Foreground slider somewhere between, the output resolution will be set to the larger of the two input resolutions to make sure there’s enough room to contain both images. In this case, you may experience undesirable resolution changes when the slider moves from full foreground or background to somewhere in between.

For example, if you try to dissolve between a 4K image (connected to the background) and an 8K image (connected to the foreground), the output of the Dissolve node will be 4K when the slider is set to full Background, but will suddenly jump to 8K when set to full Foreground or when mixed somewhere between the foreground and background.

Inspector

Dissolve controls

Controls Tab

These are the main controls that govern the Dissolve node’s behavior.

- **Operation Pop-Up**: The Operation menu contains one of seven different methods for mixing the Foreground and Background inputs. The two images are mixed using the value of the Background/Foreground slider to determine the percentage each image contributes.

- **Dissolve**: The standard Dissolve mode is the equivalent of a cross dissolve: one clip fades out as another clip fades in.

- **Additive Dissolve**: Similar in look to a standard film dissolve, an Additive dissolve adds the second clip and then fades out the first one.

- **Erode**: The Erode method transitions between the two images by growing the darkest areas of the background image to reveal the foreground image. The effect appears similar to a filmstrip burning out.

- **Random Dissolve**: A randomly generated dot pattern is used to perform the mix of the images.
– **Random Noise Dissolve**: A moving random dot pattern is used to perform the mix of the images.

– **Gradient Wipe**: The dissolve is controlled by the luminance values of the image in the Gradient Map input. The edges of this dissolve can be softened. The density and the color of the border can be adjusted independently.

– **SMPTE Wipe**: The SMPTE wipe is similar to the basic effect wipes found on many video effects switchers. There is a horizontal wipe and a vertical wipe provided. The wipes can have soft edges and borders added. The density and the color of the border can be adjusted independently.

– **Background/Foreground Slider**: Defaults to Foreground. This control determines whether the output is the background image, the foreground image, or a mix between the two. The type of mix is determined by the Operation control. If one of the input images is not currently available, the other one will be output despite the setting of this slider.

### Gradient/SMPTE Wipe Controls

The following controls appear only when Gradient Wipe or SMPTE Wipe are selected.

– **Wipe Style**: (SMPTE Wipe only) This drop-down list allows the selection of two wipe styles: Horizontal - Left to Right and Vertical - Top to Bottom. The direction of the wipes can be reversed by using the Invert Wipe checkbox.

– **Invert Wipe**: (SMPTE Wipe only) When checked, the direction of the wipe will be reversed.

– **Softness**:

– **Border**: Select the Border to enable coloring of the transition’s edge and to reveal the associated controls. The effect is to create a border around the transition edge.

– **Border Softness**: (Appears only when Border is turned on) The Border Softness slider controls the width and density of the border. Higher values will create a denser border, and lower values will create a thinner one.

– **Border Color**: (Appears only when Border is turned on) Use Border Color to select the color used in the border.

### Common Controls

**Settings Tab**

The Settings tab in the Inspector is also duplicated in both the Dissolve and Merge nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

---

**Merge [MRG]**

![Merge node](image)

The Merge node

**Merge Node Introduction**

The Merge node combines two images based on the Alpha (opacity) channel associated with the one in front. This node takes two inputs: a background and a foreground image. The Operation mode determines which method is used to combine the foreground and background images, supporting the standard Over, In, Held Out, Atop, and XOr methods for compositing images. Meanwhile, an Apply
Mode pop-up lets you use different composite modes, transfer modes, or blend modes (whichever is your preferred terminology) to combine the foreground against the background in different ways. This includes such standard modes as screen, dissolve, multiply, overlay, as well as many others.

The Merge node can perform both additive (premultiplied) and subtractive (non-premultiplied) compositing, depending on how your compositions and media are set up. However, you also have the flexibility of using the Additive/Subtractive slider to blend between additive and subtractive composite results, which has the bonus of providing solutions for problem edges in some cases.

Ordinarily, the foreground and background input connections determine the layer order of images composited with this node. However, you can also enable Z-Depth compositing if Z-channels are available in the input images. Z-merging compares the depth value of each pixel in each layer to determine which pixels should be in front and which should be behind.

**Inputs**

The Merge node provides three image inputs, all of which are optional:

- **Background**: The orange background input is for the first of two images you want to composite together. You should connect the background input before connecting the foreground input. If you connect an image to the background without connecting anything to the foreground input, the Merge node will output the background image.

- **Foreground**: The green foreground input is for the second of two images you want to composite together, which is typically a foreground subject that should be in front of the background. If you connect an image to the foreground input without connecting anything to the background input first, the Merge node won’t output anything.

- **Effect Mask**: (Optional) The effect mask input lets you mask a limited area of the output image to be merged where the mask is white (where the foreground image shows in front of the background), letting the background image show through by itself where the mask is black.

**Basic Node Setup**

Merge nodes are typically connected in the following way, with two input images connected to the background and foreground inputs, and the output connected to the next node in the composition. In this example, the effect mask input is not used, as this is not typical.

![A typical Merge node structure in DaVinci Resolve](image)

**Resolution Handling**

While you can connect images of any resolution to the background and foreground inputs of the Merge node, the image that’s connected to the background input determines the resolution of the output.

**TIP**: If you want to change the resolution of the image connected to the background, you can use the Crop node to change the “canvas” resolution of the image without changing the size of the original image, or you can use the Resize node to change both the resolution and the size of the image.
Inspector

Merge node controls

Merge Tab

The Merge tab contains most of the controls necessary for customizing most merge operations.

Foreground Sizing Controls

These controls let you adjust the sizing of the image connected to the foreground input, making it unnecessary to use a separate Transform node to fit the foreground layer to match the background layer in simple compositions.

- **Center X and Y**: This control determines the position of the foreground image in the composite. The default is 0.5, 0.5, which centers the foreground image in the exact center of the background image. The value shown is always the actual position in normalized coordinates, multiplied by the reference size. See below for a description of the reference size controls.
- **Size**: Use this control to increase or decrease the size of the foreground image before it is composited over the background. The range of values for this slider is 0.0 to 5.0, but any value greater than 0 can be entered manually. A size of 1.0 gives a pixel-for-pixel composition, where a single pixel in the foreground is the same size as a single pixel in the background.
- **Angle**: Use this control to rotate the foreground image before it is combined with the background.

Compositing Mode and Adjustment Controls

The next six parameters control how the background and foreground input images are combined to create a single output image.

- **Apply Modes**: The Apply Mode setting determines the math used when blending or combining the foreground and background pixels.
  - **Normal**: The default Normal merge mode uses the foreground’s Alpha channel as a mask to determine which pixels are transparent and which are not. When this is active, another menu shows possible operations, including Over, In, Held Out, Atop, and XOR.
– **Screen:** Screen merges the images based on a multiplication of their color values. The Alpha channel is ignored, and layer order becomes irrelevant. The resulting color is always lighter. Screening with black leaves the color unchanged, whereas screening with white will always produce white. This effect creates a similar look to projecting several film frames onto the same surface. When this is active, another menu shows possible operations, including Over, In, Held Out, Atop, and XOr.

– **Dissolve:** Dissolve mixes two image sequences together. It uses a calculated average of the two images to perform the mixture.

– **Multiply:** Multiplies the values of a color channel. This will give the appearance of darkening the image as the values are scaled from 0 to 1. White has a value of 1, so the result would be the same. Gray has a value of 0.5, so the result would be a darker image, or an image half as bright.

– **Overlay:** Overlay multiplies or screens the color values of the foreground image, depending on the color values of the background image. Patterns or colors overlay the existing pixels while preserving the highlights and shadows of the color values of the background image. The background image is not replaced but is mixed with the foreground image to reflect the original lightness or darkness of the background image.

– **Soft Light:** Soft Light darkens or lightens the foreground image, depending on the color values of the background image. The effect is similar to shining a diffused spotlight on the image.

– **Hard Light:** Hard Light multiplies or screens the color values of the foreground image, depending on the color values of the background image. The effect is similar to shining a harsh spotlight on the image.

– **Color Dodge:** Color Dodge uses the foreground’s color values to brighten the background image. This is similar to the photographic dark room technique of dodging by reducing the exposure of an area of a print.

– **Color Burn:** Color Burn uses the foreground’s color values to darken the background image. This is similar to the photographic dark room technique of burning by increasing the exposure of an area of a print.

– **Darken:** Darken looks at the color information in each channel and selects the background or foreground image’s color value, whichever is darker, as the result color. Pixels lighter than the merged colors are replaced, and pixels darker than the merged color do not change.

– **Lighten:** Lighten looks at the color information in each channel and selects the background or foreground image’s color values, whichever is lighter, as the result color value. Pixels darker than the merged color are replaced, and pixels lighter than the merged color do not change.

– **Difference:** Difference looks at the color information in each channel and subtracts the foreground color values from the background color values or the background from the foreground, depending on which has the greater brightness value. Merging with white inverts the color. Merging with black produces no change.

– **Exclusion:** Exclusion creates an effect similar to, but lower in contrast than, the Difference mode. Merging with white inverts the base color values. Merging with black produces no change.

– **Hue:** Hue creates a result color with the luminance and saturation of the background color values and the hue of the foreground color values.

– **Saturation:** Saturation creates a result color with the luminance and hue of the base color and the saturation of the blend color.

– **Color:** Color creates a result color with the luminance of the background color value and the hue and saturation of the foreground. This preserves the gray levels in the image and is useful for coloring monochrome images.
– **Luminosity**: Luminosity creates a result color with the hue and saturation of the background color values and the luminance of the foreground color values. This mode creates an inverse effect from that of the Color mode.

– **Operator Modes**: This menu is used to select the Operation mode of the merge. Changing the Operation mode changes how the foreground and background are combined to produce a result. This pop-up menu is visible only when the Merge node’s Apply mode is set to either Normal or Screen.

For an excellent description of the math underlying the Operation modes, read Compositing Digital Images, Porter, Thomas, and T. Duff, ACM SIGGRAPH Computer Graphics proceedings, 1984, pages 253-259. Essentially, the math is as described below. Note that some modes not listed in the Operator drop-down menu (Under, In, Held In, Below) are easily obtained by swapping the foreground and background inputs (with Command-T or Ctrl-T) and choosing a corresponding mode. The formula used to combine pixels in the merge is always \((fg \times x) + (bg \times y)\). The different operations determine exactly what \(x\) and \(y\) are, as shown in the description for each mode.

The Operator modes are as follows:

– **Over**: The Over mode adds the foreground layer to the background layer by replacing the pixels in the background with the pixels from the Z wherever the foreground’s Alpha channel is greater than 1.

  \[ x = 1, \quad y = 1-\text{foreground\ Alpha} \]

– **In**: The In mode multiplies the Alpha channel of the background input against the pixels in the foreground. The color channels of the foreground input are ignored. Only pixels from the foreground are seen in the final output. This essentially clips the foreground using the mask from the background.

  \[ x = \text{background\ Alpha}, \quad y = 0 \]

– **Held Out**: Held Out is essentially the opposite of the In operation. The pixels in the foreground image are multiplied against the inverted Alpha channel of the background image. Accomplish exactly the same result using the In operation and a Matte Control node to invert the matte channel of the background image.

  \[ x = 1-\text{background\ Alpha}, \quad y = 0 \]

– **Atop**: Atop places the foreground over the background only where the background has a matte.

  \[ x = \text{background\ Alpha}, \quad y = 1-\text{foreground\ Alpha} \]

– **XOr**: XOr combines the foreground with the background wherever either the foreground or the background has a matte, but never where both have a matte.

  \[ x = 1-\text{background\ Alpha}, \quad y = 1-\text{foreground\ Alpha} \]

– **Subtractive/Additive slider**: This slider controls whether Fusion performs an Additive merge, a Subtractive merge, or a blend of both. This slider defaults to Additive merging for most operations, assuming the input images are premultiplied (which is usually the case). If you don’t understand the difference between Additive and Subtractive merging, here’s a quick explanation.

  – An Additive merge is necessary when the foreground image is premultiplied, meaning that the pixels in the color channels have been multiplied by the pixels in the Alpha channel. The result is that transparent pixels are always black, since any number multiplied by 0 always equals 0. This obscures the background (by multiplying with the inverse of the foreground Alpha), and then simply adds the pixels from the foreground.
A Subtractive merge is necessary if the foreground image is not pre-multiplied. The compositing method is similar to an additive merge, but the foreground image is first multiplied by its own Alpha to eliminate any background pixels outside the Alpha area.

While the Additive/Subtractive option could easily have been a checkbox to select one mode or another, the Merge node lets you blend between the Additive and Subtractive versions of the merge operation—an operation that is occasionally useful for dealing with problem composites with edges that are calling attention to themselves as too bright or too dark.

For example, using Subtractive merging on a premultiplied image may lead to darker edges, whereas using Additive merging with a non-premultiplied image will cause any non-black area outside the foreground’s Alpha to be added to the result, thereby lightening the edges. By blending between Additive and Subtractive, you can tweak the edge brightness to be just right for your situation.

**Alpha Gain slider:** Alpha Gain linearly scales the values of the foreground’s Alpha channel. In Subtractive merges, this controls the density of the composite, similarly to Blend. In Additive merges, this effectively reduces the amount that the background is obscured, thus brightening the overall result. In an Additive merge with Alpha Gain set to 0.0, the foreground pixels are simply added to the background.

**Burn In slider:** The Burn In control adjusts the amount of Alpha used to darken the background, without affecting the amount of foreground added in. At 0.0, the merge behaves like a straight Alpha blend, whereas at 1.0, the foreground is effectively added onto the background (after Alpha multiplication if in Subtractive mode). This gives the effect of the foreground image brightening the background image, as with Alpha Gain. For Additive merges, increasing the Burn In gives an identical result to decreasing Alpha Gain.

**Blend slider:** This is a cloned instance of the Blend slider in the Common Controls tab. Changes made to this control are simultaneously made to the one in the common controls. The Blend slider mixes the result of the node with its input, blending back the effect at any value less than 1.0. In this case, it will blend the background with the merged result.

**Additional Controls**

The remaining controls let you fine-tune the results of the above settings.

**Filter Method:** For input images that are being resized, this setting lets you choose the filter method used to interpolate image pixels when resizing clips. The default setting is Linear. Different settings work better for different kinds of resizing. Most of these filters are useful only when making an image larger. When shrinking images, it is common to use the Linear filter; however, the Catmull-Rom filter will apply some sharpening to the results and may be useful for preserving detail when scaling down an image.

- **Nearest Neighbor:** This skips or duplicates pixels as needed. This produces the fastest but crudest results.
- **Box:** This is a simple interpolation resize of the image.
- **Linear:** This uses a simplistic filter, which produces relatively clean and fast results.
- **Quadratic:** This filter produces a nominal result. It offers a good compromise between speed and quality.
- **Cubic:** This produces better results with continuous-tone images. If the images have fine detail in them, the results may be blurrier than desired.
- **Catmull-Rom:** This produces good results with continuous-tone images that are resized down. Produces sharp results with finely detailed images.
- **Gaussian:** This is very similar in speed and quality to Bi-Cubic.
– **Mitchell:** This is similar to Catmull-Rom but produces better results with finely detailed images. It is slower than Catmull-Rom.

– **Lanczos:** This is very similar to Mitchell and Catmull-Rom but is a little cleaner and also slower.

– **Sinc:** This is an advanced filter that produces very sharp, detailed results; however, it may produce visible “ringing” in some situations.

– **Bessel:** This is similar to the Sinc filter but may be slightly faster.

– **Window Method:** Some filters, such as Sinc and Bessel, require an infinite number of pixels to calculate exactly. To speed up this operation, a windowing function is used to approximate the filter and limit the number of pixels required. This control appears when a filter that requires windowing is selected.

– **Hanning:** This is a simple tapered window.

– **Hamming:** Hamming is a slightly tweaked version of Hanning.

– **Blackman:** A window with a more sharply tapered falloff.

– **Kaiser:** A more complex window, with results between Hamming and Blackman.

---

Resize Filters from left to right: Nearest Neighbor, Box, Linear, Quadratic, Cubic, Catmull-Rom, Gaussian, Mitchell, Lanczos, Sinc, and Bessel

– **Edges Buttons:** Four buttons let you choose how to handle the space around images that are smaller than the current DoD of the canvas as defined by the resolution of the background image.

– **Canvas:** The area outside the frame is set to the current color/opacity of the canvas. If you want to change this value, you can attach a Set Canvas Color node between the image connected to the foreground input and the foreground input itself, using Set Canvas Color to choose a color and/or transparency setting with which to fill the canvas.

– **Wrap:** Creates a “video wall” effect by duplicating the foreground image as a grid.

– **Duplicate:** Duplicates the outermost pixels along the edge of the foreground image, duplicating them to stretch up, down, left, and right from each side to reach the end of the DoD.

– **Mirror:** Similar to duplicate, except every other iteration of the foreground image is flipped and flopped to create a repeating pattern.

– **Invert Transform:** Select the Invert Transform control to invert any position, rotation, or scaling transformation. This option is useful when connecting the merge to the position of a tracker for match moving.

– **Flatten Transform:** The Flatten Transform option prevents this node from concatenating its transformation with subsequent nodes. The node may still concatenate transforms from its input, but it will not concatenate its transformation with the node at its output.

– **Reference Size:** The controls under Reference Size do not directly affect the image. Instead, they allow you to control how Fusion represents the position of the Merge node’s center.

Normally, coordinates are represented as values between 0 and 1, where 1 is a distance equal to the full width or height of the image. This allows resolution independence, because the size of the image can be changed without having to change the value of the center.

One disadvantage to this approach is that it complicates making pixel-accurate adjustments to an image. To demonstrate, imagine an image that is 100 x 100 pixels in size. To move the center of the foreground element to the right by 5 pixels, we would change the X value of the merge center from 0.5, 0.5 to 0.55, 0.5. We know the change must be 0.05 because 5/100 = 0.05.
If you specify the dimensions of the background image in the Reference Size controls, this changes the way the center control values are displayed so that it shows the actual pixel positions in its X and Y fields.

Extending the example, set the width and height to 100 each and the center will now be shown as 50, 50, and we would move it 5 pixels toward the right by entering 55, 50.

Internally, the Merge node still stores this value as a number between 0 to 1 and, if the center control’s value was to be queried via scripting or the center control was to be published for use by other nodes, the original normalized value would be retrieved. The change is only visible in the value shown for merge center in the node control.

- **Use Frame Format Settings:** Select this to force the merge to use the composition’s current frame format settings to set the reference width and reference height values.
- **Width and Height:** Set these sliders to the width and height of the image to change the way that Fusion displays the values of the Merge node’s center control.

### Channels Tab

The Channels tab has controls that let the Merge node use Z-channels embedded within each image to define what’s in front and what’s behind during a Merge operation. The following controls let you customize the result.

- **Perform Depth Merge:** Off by default. When turned on, the Z-channel of both images will be used to determine the composite order. Alpha channels are still used to define transparency, but the values of the Z-Depth channels will determine the ordering of image elements, front to back. If a Z-channel is not available for either image, the setting of this checkbox will be ignored, and no depth compositing will take place. If Z-Depth channels are available, turning this checkbox off disables their use within this operation.

- **Foreground Z-Offset:** This slider sets an offset applied to the foreground image’s Z value. Click the Pick button to pick a value from a displayed image’s Z-channel, or enter a value using the slider or input boxes. Raising the value causes the foreground image’s Z-channel to be offset further away along the Z-axis, whereas lowering the value causes the foreground to move closer.

- **Subtractive/Additive:** When Z-compositing, it is possible for image pixels from the background to be composited in the foreground of the output because the Z-buffer for that pixel is closer than the Z of the foreground pixel. This slider controls whether these pixels are merged in an Additive or a Subtractive mode, in exactly the same way as the comparable slider in the Merge tab.

When merged over a background of a different color, the original background will still be visible in the semitransparent areas. An Additive merge will maintain the transparencies of the image but will add their values to the background.
Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in both the Dissolve and Merge nodes. These common controls are described in the following "The Common Controls" section.

The Common Controls
The Merge and Dissolve nodes share several identical controls in the Inspector. This section describes controls that are common among those two nodes.

Inspector

Settings Tab
The Settings tab in the Inspector can be found on both tools in the Composite category. The Settings controls are even found on third-party color type plug-in tools. The controls are consistent and work the same way for each tool, although some tools do include one or two individual options that are also covered here.

Blend
The Blend control is used to blend between the tool’s original image input and the tool’s final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming image. Normally, this will cause the tool to skip processing entirely, copying the input straight to the output.
Process When Blend Is 0.0
The tool is processed even when the input value is zero. This can be useful if processing of this node is scripted to trigger another task, but the value of the node is set to 0.0.

Red/Green/Blue/Alpha Channel Selector
These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.

For example, if the red button on a blur tool is deselected, the blur will first be applied to the image, then the red channel from the original input will be copied back over the red channel of the result.

There are some exceptions, such as tools for which deselecting these channels causes the tool to skip processing that channel entirely. Tools that do this will generally possess a set of identical RGBA buttons on the Controls tab in the tool. In this case, the buttons in the Settings and the Controls tabs are identical.

Apply Mask Inverted
Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

Multiply by Mask
Selecting this option will cause the RGB values of the masked image to be multiplied by the mask channel's values. This will cause all pixels of the image not in the mask (i.e., set to 0) to become black/ transparent.

Use Object/Use Material (Checkboxes)
Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports Object and Material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels will be used, if present. The specific Material ID or Object ID affected is chosen using the next set of controls.

Correct Edges
This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information on Coverage and Background Color channels, see Chapter 18, "Understanding Image Channels" in the Fusion Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.

Object ID/Material ID (Sliders)
Use these sliders to select which ID will be used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker: to grab IDs from the image displayed in the view. The image or sequence must have been rendered from a 3D software package with those channels included.

Use GPU
The Use GPU menu has three settings. Setting the menu to Disable turns off hardware-accelerated rendering using the graphics card in your computer. Enabled uses the hardware. Auto uses a capable GPU if one is available and falls back to software rendering when a capable GPU is not available.
**Motion Blur**

- **Motion Blur**: This toggles the rendering of Motion Blur on the tool. When this control is toggled on, the tool’s predicted motion is used to produce the motion blur caused by the virtual camera’s shutter. When the control is toggled off, no motion blur is created.

- **Quality**: Quality determines the number of samples used to create the blur. A quality setting of 2 will cause Fusion to create two samples to either side of an object’s actual motion. Larger values produce smoother results but increase the render time.

- **Shutter Angle**: Shutter Angle controls the angle of the virtual shutter used to produce the motion blur effect. Larger angles create more blur but increase the render times. A value of 360 is the equivalent of having the shutter open for one whole frame exposure. Higher values are possible and can be used to create interesting effects.

- **Center Bias**: Center Bias modifies the position of the center of the motion blur. This allows the creation of motion trail effects.

- **Sample Spread**: Adjusting this control modifies the weighting given to each sample. This affects the brightness of the samples.

**Comments**

The Comments field is used to add notes to a tool. Click in the field and type the text. When a note is added to a tool, a small red square appears in the lower left corner of the node when the full tile is displayed or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the node editor, hold the mouse pointer over the node to display the tooltip.

**Scripts**

Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
This chapter details Deep Pixel nodes found in Fusion. Deep Pixel nodes are capable of handling AOVs (Arbitrary Output Variables) from 3D-rendered files. The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

Ambient Occlusion [SSAO] 1887
Depth Blur [DBl] 1890
Fog [Fog] 1892
Shader [Shd] 1894
Texture [Txr] 1897
The Common Controls 1899
Ambient Occlusion [SSAO]

The Ambient Occlusion node

Ambient Occlusion Node Introduction

Ambient Occlusion (AO) is the lighting caused when a scene is surrounded by a uniform diffuse spherical light source. Think of the scene as being surrounded by a humongous sphere that uniformly emits light from its surface. AO captures the low frequency lighting. It does not capture sharp shadows or Diffuse or Specular lighting. So, AO is usually combined with Diffuse and Specular lighting to create a full lighting solution.

The Ambient Occlusion node generates global lighting effects in 3D-rendered scenes as a post effect. It quickly approximates computationally expensive ray-traced global illumination. Being a post effect, it exposes similar aliasing issues like the Shader, Texture, and Volume Fog nodes. Hence, artifacts may appear in certain situations.

Usage

The AO node rarely works out of the box, and requires some tweaking. The setup process involves adjusting the Kernel Radius and Number Of Samples to get the desired affect.

The Kernel Radius depends on the natural “scale” of the scene. Initially, there might appear to be no AO at all. In most cases, the Kernel Radius is too small or too big, and working values must be found.

Inputs

There are three inputs on the AO node. The standard effect mask is used to limit the AO effect. The Input and Camera connections are required. If either of these is not supplied, the node does not render an image on output.

- **Input**: This orange input accepts a 2D RGBA image, Z-Depth, and Normals.
- **Camera**: The green camera input can take either a 3D Scene or a 3D Camera that rendered the 2D image.
- **Effect Mask**: The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the Ambient Occlusion to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

The Ambient Occlusion node is typically placed after a Renderer 3D node. The Renderer 3D node must have Z-Depth and Normals enabled in its output channels. The Camera3D that is rendered by the Renderer3D node is then connected to the camera input on the AO node.
Controls Tab

The controls tab includes all the main controls for compositing with AO. It controls the quality and appearance of the effect.

Output Mode

- **Color**: Using the Color menu option combines the incoming image with Ambient Occlusion applied.

- **AO**: This option outputs the pure Ambient Occlusion as a grayscale image. White corresponds to regions in the image that should be bright, while black corresponds to regions that should be darker. This allows you to create a lighting equation by combining separate ambient/diffuse/specular passes. Having the AO as a separate buffer allows creative freedom to combine the passes in various ways.
**Kernel Type**

To determine the AO, rays are cast from a point on the surface being shaded, outward to a large enclosed sphere.

The AO factor is determined by the unoccluded rays that reach the sphere.

- **Hemisphere**: Rays are cast toward a hemisphere oriented to the surfaces normal. This option is more realistic than Sphere and should be used unless there is a good reason otherwise. Flat surfaces receive 100% ambient intensity, while other parts are darkened.

- **Sphere**: Rays are cast toward a sphere centered about the point being shaded. This option is provided to produce a stylistic effect. Flat surfaces receive 50% ambient intensity, while other parts are made darker or brighter.

**Number of Samples**

Increase the samples until artifacts in the AO pass disappear. Higher values can generate better results but also increase render time.

**Kernel Radius**

The Kernel Radius controls the size of the filter kernel in 3D space. For each pixel, it controls how far one searches in 3D space for occluders. The Filter Kernel should be adjusted manually for each individual scene.

If made too small, nearby occluders can be missed. If made too large, the quality of the AO decreases and the samples must be increased dramatically to get the quality back.

This value is dependent on the scene Z-depth. That means with huge Z values in the scene, the kernel size must be large as well. With tiny Z values, a small kernel size like 0.1 should be sufficient.

**Lift/Gamma/Tint**

You can use the lift, gamma, and tint controls to adjust the AO for artistic effects.

**Common Controls**

**Settings Tab**

The Settings tab in the Inspector is also duplicated in other Deep Pixel nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

**TIP:** Combining multiple AO passes with different kernel radii can produce better effects.

**AO Tips and Limitations**

Transparency/Translucency: AO is designed to work with opaque objects. There are known limitations with transparent receivers and those with transparent occluders. You can work around some of these limitations by splitting out the transparent/translucent objects into separate scenes and only computing AO on the opaque objects.
**Particles:** Because of the transparency/translucency limitations, do not use AO on particles, unless the particles are solid opaque geometry. Anti-aliased edges are another form of transparency, so they also cause problems with AO.

**Supersampling:** To render anti-aliasing with Ambient Occlusion, enable HiQ for the Z and Normals pass in the Renderer 3D.

**Viewer Dependence:** AO methods work in viewer space, and the results are viewer dependent. This means the amount of darkening can vary depending on the view location, when in reality it should be constant. If at a point on an object the AO is 0.5, moving the camera could change it to 0.4.

**Baking of AO:** The OpenGL UV renderer can be used to bake AO into the textures on models.

---

**Depth Blur [DBl]**

The Depth Blur node

**Depth Blur Node Introduction**

The Depth Blur node is primarily used to create focal length or depth-of-field effects. It blurs 3D-rendered images based on included Z-channel values, and can also be used for general per-pixel blurring effects through the Blur Channel controls.

**Inputs**

The Depth Blur node includes three inputs: one for the main image, one for a blur image, and another for an effect mask to limit the area where the depth blur is applied.

- **Input:** This orange input is the only required connection. It accepts a 2D image that includes a Z channel. The Z channel is used to determine the blur amount in different regions of the image.
- **Blur Image:** If the Blur Image input is connected, channels from the image are used to control the blur. This allows general 2D per-pixel blurring effects.
- **Effect Mask:** The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the depth blur to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.

**Basic Node Setup**

The Depth Blur node receives the image containing the Z channel. Below, the Z depth channel is provided in a separate image file and combined with the RGB (beauty) image using a Channels Booleans tool. Channel Booleans sets the Z buffer channel to copy into the luminance foreground.
Depth Blur is applied to the beauty image based on a Z depth channel

**Inspector**

**Controls Tab**

The Controls tab includes parameters for adjusting the amount of blur applied and the depth of the blurred area. It also includes options for selecting channels other than the Z channel for the blur map.

**Filter**

This menu selects the filter used for the blur.

- **Box**: This applies a basic depth-based box blur effect to the image.
- **Soften**: This applies a depth-based general softening filter effect.
- **Super Soften**: This applies a depth-based high-quality softening filter effect.

**Blur Channel**

Select one of these options to determine the channel used to control the level of blur applied to each pixel. The channel from the main image input is used, unless an image is connected to the node’s green Blur Image input.

**Lock X/Y**

When toggled on, this control locks the X and Y Blur sliders together for symmetrical blurring.

**Blur Size**

This slider is used to set the strength of the horizontal and vertical blurring.

**Focal Point**

This control is visible only when the Blur channel menu is set to use the Z channel.

Use this control to select the distance of the simulated point of focus. Lowering the value causes the Focal Point to be closer to the camera; raising the value causes the Focal Point to be farther away.
Depth of Field

This control is used to determine the depth of the area in focus. The focal point is positioned in the middle of the region, and all pixels with a Z-value within the region stay in focus. For example, if the focal point were selected from the image and set to a value of 300, and the depth of field is set to 200, any pixel with a Z-value between 200 and 400 would remain in focus.

Z Scale

Scales the Z-buffer value by the selected amount. Raising the value causes the distances in the Z-channel to expand. Lowering the value causes them to contract. This is useful for exaggerating the depth effect. It can also be used to soften the boundaries of the blur. Some images with small depth values may require the Z-scale to be set quite low, below 1.0.

Common Controls

Settings Tab

The Settings tab in the Inspector is also duplicated in other Deep Pixel nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Fog [Fog]

The Fog node

Fog Node Introduction

The Fog node is used to create simulated fog effects on 3D-rendered images that contain a valid Z-buffer channel. The fog can be placed in front of or behind various elements of a rendered image based on the selected Z-channel planes.

Inputs

The Fog node includes three inputs: one for the main image with a Z channel, one for a blur image, and another for an effect mask to limit the area where the depth blur is applied.

- **Input:** This orange input is the only required connection. It accepts a 2D image that includes a Z channel. The Z channel is used to determine the fog amount in different regions of the image.

- **Blur Image:** The green second image input connects an image that is used as the source of the fog. If no image is provided, the fog consists of a single color. Generally, a noise map of some sort is connected here.

- **Effect Mask:** The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the fog to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

The Fog node is typically placed after a Renderer 3D node. The Renderer 3D node must have Z-Depth enabled in its output channels.
A Fog node added as a 2D post process after the Renderer 3D node

Inspector

Fog controls

Controls Tab
The Controls tab includes parameters for adjusting the density and color of the fog.

Z-Buffer Near Plane and Far Plane
These controls are used to select the extents of the fog within the scene. To pick a value, drag the Pick button to an area on the image being viewed where the plane is to be located.

The Near Plane is used to select the depth where the fog thins out to nothing. The Far Plane is used to select the depth at which the fog becomes opaque.

Z Depth Scale
This option scales the Z-buffer values by the selected amount. Raising the value causes the distances in the Z-channel to expand, whereas lowering the value causes the distances to contract. This is useful for exaggerating the fog effect.
**Fog Color**
This option displays and controls the current fog color. Alpha adjusts the fog's transparency value.

**Fog Opacity**
Use this control to adjust the opacity on all channels of the fog.

**Common Controls**

**Settings Tab**
The Settings tab in the Inspector is also duplicated in other Deep Pixel nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

---

**Shader [Shd]**

The **Shader node** can control the lighting, reflection mapping, and 3D shading of elements in a rendered image. The node relies on the presence of the normal map channel in a rendered image. If this channel is not present, this node has no effect.

**Inputs**
The Shader node includes three inputs: one for the main image with normal map channels, one for a reflection map, and another for an effect mask to limit the area where the depth blur is applied.

- **Input:** This orange input is the only required connection. It accepts a 2D image that includes a normals channel.

- **Reflection Map Image:** The green reflection map image input projects an image onto all elements in the scene or to elements selected by the Object and Material ID channels in the Common Controls. Reflection maps work best as 32-bit floating point, equirectangular formatted images.

- **Effect Mask:** The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the shader to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.

**Basic Node Setup**
The Shader node is inserted after a 2D image that contains a Normals channel. Below, a Renderer 3D is used to add a Normals channel to an image. The Shader node uses the normals for refining the surface appearance with a reflection map connected.
Inspector

Shader controls

Controls Tab

The Controls tab for the Shader node includes parameters for adjusting the overall surface reaction to light sources. You can modify the ambient, diffuse, specular, and reflection properties of the image connected to the orange image input.

Light Tab

The Controls tab includes parameters for basic lighting brightness and reflections.

Ambient

Ambient controls the Ambient color present in the scene or the selected object. This is a base level of light added to all pixels, even in completely shadowed areas.

Diffuse

This option controls the Diffuse color present in the scene or for the selected object. This is the normal color of the object, reflected equally in all directions.

Specular

This option controls the Specular color present in the scene or for the selected object. This is the color of the glossy highlights reflected toward the eye from a light source.

Reflection

This option controls the Reflection contribution in the scene or for the selected object. High levels make objects appear mirrored, while low levels overlay subtle reflections giving a polished effect. It has no effect if no reflection map is connected.
**Reflection Type**
This menu determines the type of reflection mapping used to project the image in the second input.

- **Screen:** Screen causes the reflection map to appear as if it were projected on to a screen behind the point of view.
- **Spherical:** Spherical causes the reflection map to appear as if it were projected on to a huge sphere around the whole scene.
- **Refraction:** Refraction causes the reflection map to appear as if it were refracting or distorting according to the geometry in the scene.

**Equator Angle**
Equator Angle controls the left to right angle of the light generated and mapped by the Shader node for the scene or the selected object.

**Polar Height**
Polar Height controls the top to bottom angle of the light generated and mapped by the Shader node for the scene or the selected object.

**Shader Tab controls**

**Shader Tab**
The Shader tab is used to adjust the falloff of the Diffuse and Specular light and the tint color of the specular highlight.

**Diffuse and Specular**
When enabled, these checkboxes allow you to edit the Diffuse and/or Specular Shader curves in the Shader spline window.

**In and Out**
These options are used to display and edit point values on the spline.
Specular Color

Use the Diffuse curve to manipulate the diffuse shading and the Specular curve to affect the specular shading. Drag a box over several points to group-select them. Right-clicking displays a menu with options for adjusting the spline curves.

Common Controls

Settings Tab

The Settings tab in the Inspector is also duplicated in other Deep Pixel nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

Texture [Txr]

Texture Node Introduction

The Texture node controls the texture mapping of elements in a rendered image. The Texture node relies on the presence of U and V Map channels in a 3D-rendered image connected to the main Image input. If these channels are not present, this node has no effect.

NOTE: Background pixels may have U and V values of 0.0, which set those pixels to the color of the texture’s corner pixel. To restrict texturing to specific objects, use an effect mask based on the Alpha of the object or its Object or Material ID channel.

Inputs

The Texture node includes three inputs: one for the main image with UV map channels, one for a texture map image, and another for an effect mask to limit the area where the replace texture is applied.

- **Input**: This orange input accepts a 2D image that includes UV channels. If the UV channels are not in the images, this node has no effect.
- **Texture**: The green texture map input provides the texture that is wrapped around objects, replacing the current texture.
- **Effect Mask**: The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the texture to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.
Basic Node Setup

The Texture node is inserted after a 2D image that contains a Texture UV channel. Below, a Renderer 3D is used to add texture coordinates to 3D text. The Texture node can then be used to manipulate those coordinates using a new texture connected to the green texture input.

A Texture node used to manipulate the texture coordinates and add texture to a Text 3D node

Inspector

Texture controls

Texture Tab

The Texture tab controls allow you to flip, swap, scale, and offset the UV texture image connected to the texture input.

Flip Horizontal and Vertical
Use these two buttons to flip the texture image horizontally and/or vertically.

Swap UV
When this checkbox is selected, the U and V channels of the source image are swapped.

Rotate 90
The texture map image is rotated 90 degrees when this checkbox is enabled.

U and V Scale
These controls change the scaling of the U and V coordinates used to map the texture. Changing these values effectively enlarges and shrinks the texture map as it is applied.

U and V Offset
Adjust these controls to offset the U and V coordinates. Changing the values causes the texture to appear to move along the geometry of the object.
Common Controls

**Settings Tab**
The Settings tab in the Inspector is also duplicated in other Deep Pixel nodes. These common controls are described in the following “The Common Controls” section.

## The Common Controls

Nodes that handle Deep Pixel compositing operations share several identical controls in the Inspector. This section describes controls that are common among Deep Pixel nodes.

### Inspector

[Image of Common Settings tab in Deep Pixel Nodes]

**Settings Tab**
The Settings tab in the Inspector can be found on every tool in the Deep Pixel category. The Settings controls are even found on third-party Deep Pixel-type plug-in tools. The controls are consistent and work the same way for each tool although some tools do include one or two individual options that are also covered here.

**Blend**
The Blend control is used to blend between the tool’s original image input and the tool’s final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming image. Normally, this causes the tool to skip processing entirely, copying the input straight to the output.

**Process When Blend Is 0.0**
The tool is processed even when the input value is zero. This can be useful if processing of this node is scripted to trigger another task, but the value of the node is set to 0.0.
Red/Green/Blue/Alpha Channel Selector
These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.

For example, if the red button on a Blur tool is deselected, the blur is first applied to the image, and then the red channel from the original input is copied back over the red channel of the result.

There are some exceptions, such as tools for which deselecting these channels causes the tool to skip processing that channel entirely. Tools that do this generally possess a set of identical RGBA buttons on the Controls tab in the tool. In this case, the buttons in the Settings and the Controls tabs are identical.

Apply Mask Inverted
Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

Multiply by Mask
Selecting this option causes the RGB values of the masked image to be multiplied by the mask channel's values. This causes all pixels of the image not in the mask (i.e., set to 0) to become black/transparent.

Use Object/Use Material (Checkboxes)
Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports Object and Material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels are used if present. The specific Material ID or Object ID affected is chosen using the next set of controls.

Correct Edges
This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option is disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information, see Chapter 18, “Understanding Image Channels” in the Fusion Studio Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.

Object ID/Material ID (Sliders)
Use these sliders to select which ID is used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker: to grab IDs from the image displayed in the viewer. The image or sequence must have been rendered from a 3D software package with those channels included.

Use GPU
The Use GPU menu has three settings. Setting the menu to Disable turns off hardware-accelerated rendering using the graphics card in your computer. Enabled uses the hardware. Auto uses a capable GPU if one is available, but falls back to software rendering when a capable GPU is not available.
Motion Blur

- **Motion Blur**: This toggles the rendering of Motion Blur on the tool. When this control is toggled on, the tool’s predicted motion is used to produce the motion blur caused by the virtual camera’s shutter. When the control is toggled off, no motion blur is created.

- **Quality**: Quality determines the number of samples used to create the blur. A quality setting of 2 causes Fusion to create two samples to either side of an object’s actual motion. Larger values produce smoother results but increase the render time.

- **Shutter Angle**: Shutter Angle controls the angle of the virtual shutter used to produce the motion blur effect. Larger angles create more blur but increase the render times. A value of 360 is the equivalent of having the shutter open for one whole frame exposure. Higher values are possible and can be used to create interesting effects.

- **Center Bias**: Center Bias modifies the position of the center of the motion blur. This allows the creation of motion trail effects.

- **Sample Spread**: Adjusting this control modifies the weighting given to each sample. This affects the brightness of the samples.

Comments

The Comments field is used to add notes to a tool. Click in the field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

Scripts

Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
Chapter 98

Effect Nodes

This chapter details the Effect nodes in Fusion.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

Duplicate [Dup] 1903
Highlight [HIL] 1909
Hot Spot [HOT] 1911
Pseudo Color [PSCL] 1917
Rays [CIR] 1918
Shadow [SH] 1920
Trails [TRLS] 1922
TV [TV] 1927
The Common Controls 1930
Duplicate [Dup]

The Duplicate node

Duplicate Node Introduction

Similar to the Duplicate 3D node, the Duplicate node can be used to quickly duplicate any 2D image, applying a successive transformation to each, and creating repeating patterns and complex arrays of objects. The options in the Jitter tab allow for non-uniform transformations, such as random positioning or sizes.

Inputs

The two inputs on the Duplicate node are used to connect a 2D image and an effect mask, which can be used to limit the area where duplicated objects appear.

- **Input:** The orange input is used for the primary 2D image that is duplicated.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the duplicated objects to appear only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

The Duplicate node can be used in a variety of different ways and with a variety of different inputs. Below, to create motion graphics, a masked Background node creates a circular shape that is duplicated in the Duplicate node.

A Duplicate node used to create a repeating circular object
Inspector

Controls Tab
The Controls tab includes all the parameters you can use to create, offset, and scale copies of the object connected to the input on the node.

Copies
Use this slider to set the number of copies made. Each copy is a copy of the last copy. So, when set to 5, the parent is copied, then the copy is copied, then the copy of the copy is copied, and so on. This allows for some interesting effects when transformations are applied to each copy using the following controls.

Time Offset
Use the Time Offset slider to offset any animations that are applied to the original image by a set amount per copy. For example, set the value to -1.0 and use a square set to rotate on the Y-axis as the source. The first copy shows the animation from a frame earlier. The second copy shows animation from a frame before that, and so forth. This can be used with great effect on textured planes, for example, where successive frames of a clip can be shown.

Center
The X and Y Center controls set the offset position applied to each copy. An X offset of 1 would offset each copy 1 unit along the X-axis from the last copy.

Pivot
The Pivot controls determine the position of the pivot point used when changing the size, position, or angle of each copy. The pivot does not move with the original object or the duplicated array. To have the pivot follow the army, you must modify the pivot controls.

Size
The Size control determines how much scaling to apply to each copy.

Angle
The Angle control sets the amount of Z rotation applied to each copy. The angle adjustment is linear based on the location of the pivot point.
Apply Mode

The Apply Mode setting determines the math used when blending or combining duplicated objects that overlap.

- **Normal**: The default mode uses the foreground object’s Alpha channel as a mask to determine which pixels are transparent and which are not. When this is active, another menu shows possible operations, including Over, In, Held Out, Atop, and XOR.

- **Screen**: Screen blends the objects based on a multiplication of their color values. The Alpha channel is ignored, and layer order becomes irrelevant. The resulting color is always lighter. Screening with black leaves the color unchanged, whereas screening with white always produces white. This effect creates a similar look to projecting several film frames onto the same surface. When this is active, another menu shows possible operations, including Over, In, Held Out, Atop, and XOR.

- **Dissolve**: Dissolve mixes overlapping objects. It uses a calculated average of the objects to perform the mixture.

- **Multiply**: Multiplies the values of a color channel. This gives the appearance of darkening the object as the values are scaled from 0 to 1. White has a value of 1, so the result would be the same. Gray has a value of 0.5, so the result would be a darker object or, in other words, an object half as bright.

- **Overlay**: Overlay multiplies or screens the color values of the foreground object, depending on the color values of the object behind. Patterns or colors overlay the existing pixels while preserving the highlights and shadows of the color values of the objects behind the foreground objects. Objects behind other objects are not replaced but mixed with the front objects to reflect the original lightness or darkness of the objects behind.

- **Soft Light**: Soft Light darkens or lightens the foreground object, depending on the color values of the objects behind them. The effect is similar to shining a diffused spotlight on the image.

- **Hard Light**: Hard Light multiplies or screens the color values of the foreground object, depending on the color values of the objects behind them. The effect is similar to shining a harsh spotlight on the image.

- **Color Dodge**: Color Dodge uses the foreground object’s color values to brighten the objects behind them. This is similar to the photographic practice of dodging by reducing the exposure of an area of a print.

- **Color Burn**: Color Burn uses the foreground object’s color values to darken the objects behind them. This is similar to the photographic practice of burning by increasing the exposure of an area of a print.

- **Darken**: Darken looks at the color information in each channel and selects the object’s foreground or background’s color value, whichever is darker, as the result color. Pixels lighter than the blended colors are replaced, and pixels darker than the blended color do not change.
– **Lighten**: Lighten looks at the color information in each channel and selects the object’s foreground or background’s color values, whichever is lighter, as the result color value. Pixels darker than the blended color are replaced, and pixels lighter than the blended color do not change.

– **Difference**: Difference looks at the color information in each channel and subtracts the foreground object’s color values from the background object’s color values or the behind object’s values from the foreground object’s values, depending on which has the higher brightness value. Blending with white inverts the color. Blending with black produces no change.

– **Exclusion**: Exclusion creates an effect similar to but lower in contrast than the Difference mode. Blending with white inverts the base color values. Blending with black produces no change.

– **Hue**: Hue creates a result color with the luminance and saturation of the background objects color values and the hue of the foreground object’s color values.

– **Saturation**: Saturation creates a result color with the luminance and hue of the base color and the saturation of the blend color.

– **Color**: Color creates a result color with the luminance of the background object’s color value and the hue and saturation of the objects in the foreground. This preserves the gray levels in the image and is useful for colorizing monochrome objects.

– **Luminosity**: Luminosity creates a color using the hue and saturation of the background object and the luminance of the foreground object. This mode creates an inverse effect from that of the Color mode.

**Operator**

This menu is used to select the Operation mode used when the duplicate objects overlap. Changing the Operation mode changes how the overlapping objects are combined. This drop-down menu is visible only when the Apply mode is set to Normal.

The formula used to combine pixels in the Duplicate node is always \((fg \text{ object} \times x) + (bg \text{ object} \times y)\). The different operations determine what \(x\) and \(y\) are, as shown in the description for each mode.

The Operator Modes are as follows:

– **Over**: The Over mode adds the foreground object to the background object by replacing the pixels in the background with the pixels from the Z wherever the foreground object’s Alpha channel is greater than 1.

  \[
  x = 1, \ y = 1 - \text{[foreground object Alpha]}
  \]

– **In**: The In mode multiplies the Alpha channel of the background object against the pixels in the foreground object. The color channels of the foreground object are ignored. Only pixels from the foreground object are seen in the final output. This essentially clips the foreground object using the mask from the background object.

  \[
  x = \text{[background Alpha]}, \ y = 0
  \]

– **Held Out**: Held Out is essentially the opposite of the In operation. The pixels in the foreground object are multiplied against the inverted Alpha channel of the background object.

  \[
  x = 1 - \text{[background Alpha]}, \ y = 0
  \]

– **Atop**: Atop places the foreground object over the background object only where the background object has a matte.

  \[
  x = \text{[background Alpha]}, \ y = 1 - \text{[foreground Alpha]}
  \]

– **XOr**: XOr combines the foreground object with the background object wherever either the foreground or the background have a matte, but never where both have a matte.

  \[
  x = 1 - \text{[background Alpha]}, \ y = 1 - \text{[foreground Alpha]}
  \]
**Subtractive/Additive**

This slider controls whether Fusion performs an Additive composite, a Subtractive composite, or a blend of both when the duplicate objects overlap. This slider defaults to Additive assuming the input image's Alpha channel is premultiplied (which is usually the case). If you don't understand the difference between Additive and Subtractive compositing, here's a quick explanation.

An Additive blend operation is necessary when the foreground image is premultiplied, meaning that the pixels in the color channels have been multiplied by the pixels in the Alpha channel. The result is that transparent pixels are always black since any number multiplied by 0 always equals 0. This obscures the background (by multiplying with the inverse of the foreground Alpha), and then adds the pixels from the foreground.

A Subtractive blend operation is necessary if the foreground image is not premultiplied. The compositing method is similar to an additive composite, but the foreground image is first multiplied by its Alpha, to eliminate any background pixels outside the Alpha area.

While the Additive/Subtractive option is often an either/or mode in most other applications, the Duplicate node lets you blend between the Additive and Subtractive versions of the compositing operation. This can be useful for dealing with problem composites with bright or dark edges.

For example, using Subtractive merging on a premultiplied image may result in darker edges, whereas using Additive merging with a non-premultiplied image causes any non-black area outside the foreground’s Alpha to be added to the result, thereby lightening the edges. By blending between Additive and Subtractive, you can tweak the edge brightness to be just right for your situation.

**Gain**

The Gain RGB controls multiply the values of the image channel linearly. All pixels are multiplied by the same factor, but the effect is larger on bright pixels and smaller on dark pixels. Black pixels are not changed since multiplying any number times 0 always equals 0.

Alpha Gain linearly scales the Alpha channel values of objects in front. This effectively reduces the amount that the objects in the background are obscured, thus brightening the overall result. When the Subtractive/Additive slider is set to Additive with Alpha Gain set to 0.0, the foreground pixels are simply added to the background.

When Subtractive/Additive slider is set to Subtractive, this controls the density of the composite, similarly to Blend.

**Burn In**

The Burn In control adjusts the amount of Alpha used to darken the objects that fall behind other objects, without affecting the amount of foreground objects added. At 0.0, the blending behaves like a straight Alpha blend, in contrast to a setting of 1.0 where the objects in the front are effectively added on to the objects in the back (after Alpha multiplication if in Subtractive mode). This gives the effect of the foreground objects brightening the objects in the back, as with Alpha Gain. In fact, for Additive blends, increasing the Burn In gives an identical result to decreasing Alpha Gain.

**Blend**

This blend control is different from the Blend slider in the Common Settings tab. Changes made to this control apply the blend between objects. The Blend slider fades the results of the last object first, the penultimate after that, and so on. The blending is divided between 0 and 1, with 1 being all objects are fully opaque and 0 being only the original object showing.

**Merge Under**

This checkbox reverses the layer order of the duplicated elements, making the last copy the bottommost layer and the first copy the topmost layer.
Jitter Tab

The options in the Jitter tab allow you to randomize the position, rotation, size, and color of all the copies created in the Controls tab.

Random Seed

The Random Seed slider and Reseed button are used to generate a random starting point for the amount of jitter applied to the duplicated objects. Two Duplicate nodes with identical settings but different random seeds produce two completely different results.

Center X and Y

Use these two controls to adjust the amount of variation in the X and Y position of the duplicated objects.

Axis X and Y

Use these two controls to adjust the amount of variation in the rotational pivot center of the duplicated objects. This affects only the additional jitter rotation, not the rotation produced by the Rotation settings in the Controls tab.

X Size

Use this control to adjust the amount of variation in the Scale of the duplicated objects.

Angle

Use this dial to adjust the amount of variation in the Z rotation of the duplicated objects.

Gain

The Gain RGBA controls randomly multiply the values of the image channel linearly.

Blend

Changes made to this control randomize the blend between objects.

Common Controls

Settings Tab

The Settings tab controls are common to all Effect nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.
Highlight [HIL]

Highlight Node Introduction

The Highlight filter creates star-shaped highlights or glints in bright regions of the image, similar to a lens star filter effect.

Inputs

There are three Inputs on the Highlight node: one for the image, one for the effects mask, and another for a highlight mask.

- **Input:** The orange input is used for the primary 2D image that gets the highlight applied.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input restricts the highlight to be within the pixels of the mask. An effects mask is applied to the tool after the tool is processed.
- **Highlight Mask:** The Highlight node supports pre-masking using the white highlight mask input. The image is filtered before the highlight is applied. The highlight is then merged back over the original image. Unlike regular effect masks, it does not crop off highlights from source pixels when the highlight extends past the edges of the mask.

Highlight masks are identical to effects masks in every other respect.

Basic Node Setup

The Highlight node below is used to create glint-type highlights on an incoming image. The highlight mask is used to limit the area where the effect is applied.
Inspector

Controls Tab
The Controls tab includes parameters for the highlight style except for color, which is handled in the Color Scale tab.

Low and High
This range control designates the range of Luminance values in the image that generates highlights. Values less than the Low value do not receive highlights. Values above the High value receive the full highlight effect.

Curve
The Curve value changes the drop-off over the length of the highlight. Higher values cause the brightness of the flares to drop off closer to the center of the highlight, whereas lower values drop off farther from the center.

Length
This designates the length of the flares from the highlight.

Number of Points
This determines the number of flares emanating from the highlight.

Angle
Use this control to rotate the highlights.

Merge Over
When enabled, the effect is overlaid on the original image. When disabled, the output is the highlights only. This is useful for downstream color correction of the highlights.
Color Scale Tab

The Color Scale tab controls the color of the highlight.

**Red, Green, and Blue Scale**

Moving the sliders of one or all of these channels down changes the falloff color of the highlight.

**Alpha Scale**

Moving the Alpha slider down makes highlight falloff more transparent.

Common Controls

**Setting Tab**

The Settings tab controls are common to all Effect nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.

---

**Hot Spot [HOT]**

![Hot Spot node](image)

**Hot Spot Node Introduction**

The Hot Spot node is used to create lens flare, spotlight, and burn/dodge effects of various types.

In the real world, lens flares occur when extremely bright light sources in the scene by the reflections are reflected off elements inside the lens of the camera. One might see lens flares in a shot when viewing a strong light source through a camera lens, like the sun or another bright star.

**Inputs**

There are three inputs on the Hot Spot node: one for the image, one for the effects mask, and another for an Occlusion image.

- **Input:** The required orange input is used for the primary 2D image that gets the hot spot applied.

- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input restricts the hot spot to be within the pixels of the mask. An effects mask is applied to the tool after the tool is processed.

- **Occlusion:** The green Occlusion input accepts an image to provide the occlusion matte. The matte is used to block the hot spot, causing it to “wink.” The white pixels in the image occlude the hot spot. Gray pixels partially suppress the hot spot.

**Basic Node Setup**

The Hot Spot node is not a stand-alone generator, so it must have an image input that gets the hot spot applied.
Inspector

The Hotspot tab is used to control the primary and secondary hot spots. You can adjust their position, size, strength, angle, and apply mode.

Primary Center X and Y
This is the position of the primary hot spot within the scene. Secondary lens elements and reflections are positioned relative to the position of the primary hot spot.

Primary Strength
This control determines the brightness of the primary hot spot.

Hot Spot Size
This control determines the diameter of the primary hot spot. A value of 1.0 represents a circle the full width of the image.

Aspect
This controls the aspect of the spot. A value of 1.0 produces a perfectly circular hot spot. Values above 1.0 elongate the circle horizontally, and values below 1.0 elongate the circle vertically.

Aspect Angle
This control can be used to rotate the primary hot spot.

Secondary Strength
This control determines the strength, which is to say the brightness, of the secondary hot spot. The secondary hot spot is a reflection of the primary hot spot. It is always positioned on the opposite side of the image from the primary hot spot.

Secondary Size
This determines the size of the secondary hot spot.
Apply Mode
This control determines how the hot spot affects the underlying image.

- **Add (Burn):** This causes the spots created to brighten the image.
- **Subtract (Dodge):** This causes the spots created to dim the image.
- **Multiply (Spotlight):** This causes the spots created to isolate a portion of the image with light and to darken the remainder of the image.

Occlude
This menu is used to select which channel of the image connected to the Hot Spot node’s Occlusion input is used to provide the occlusion matte. Occlusion can be controlled from Alpha or R, G, or B channels of any image connected to the Occlusion input on the node’s tile.

Lens Aberration
Aberration changes the shape and behavior of the primary and secondary hot spots.

- **In and Out Modes:** Elongates the shape of the hot spot into a flare. The hot spot stretches toward the center when set to In mode and stretches toward the corners when set to Out mode.
- **Flare In and Flare Out Modes:** This option is a lens distortion effect that is controlled by the movement of the lens effect. Flare In causes the effect to become more severe, the closer the hot spot gets to the center. Flare Out causes the effect to increase as the hot spot gets closer to the edges of the image.
- **Lens:** This mode emulates a round, ringed lens effect.

Aberration
The Aberration slider controls the overall strength of the lens aberration effect.

Color Tab
The Color tab is used to modify the color of the primary and secondary hot spots.

Color Mode
This menu allows you to choose between animated or static color modifications using the small curves editor in the Inspector.

- **None:** The default None setting retains a static curve adjustment for the entire range.
- **Animated Points:** This setting allows the color curves in the spline area to be animated over time. Once this option is selected, moving to the desired frame and making a change in the Spline Editor sets a keyframe.
- **Dissolve mode:** Dissolve mode is mostly obsolete and is included for compatibility reasons only.
Color Channel and Mix

When selected, these checkboxes enable the editing of the chosen splines in the small Inspector Spline Editor. The Mix checkbox enables the Mix Spline, which is used to determine the influence of the controls that the Radial tab has along the radius of the hot spot.

Red, Green, Blue, and Alpha Splines

The Spline Window shows the curves for the individual channels. It is a miniature Spline Editor. The Red, Green, Blue, and Alpha splines are used to adjust the color of the spotlight along the radius of the hot spot.

The vertical axis represents the intensity or strength of the color channel. The horizontal axis represents the hot spot position along the radius, from the left outside edge to the inside right edge.

The default curve indicates that the red, green, blue, and Alpha channels all have a linear falloff.

Mix Spline

The Mix spline is used to determine the influence that the Radial controls have along the radius of the hot spot. The horizontal axis represents the position along the circle’s circumference, with 0 being 0 degrees and 1.0 being 360 degrees. The vertical axis represents the amount of the radial hot spot to blend with the color hot spot. A value of 0 is all radial hot spot, while a value of 1.0 is all color hot spot.

**NOTE:** Right-clicking in the LUT displays a contextual menu with options related to modifying spline curves.

For more information on the LUT Editor, see Chapter 7, “Using Viewers” in the Fusion Studio Reference Manual or Chapter 68 in the DaVinci Resolve Reference Manual.

Radial Tab

**Radial On**

This control enables the Radial splines. Otherwise, the radial matte created by the splines is not applied to the hot spot, and the Mix spline in the color controls does not affect the hot spot.

**Radial Mode**

Similar to the Color mode menu, this menu allows you to choose between animated or static radial hot spot modifications using the small curves editor in the Inspector.
– **No Animation**: The default setting retains a static curve adjustment for the entire range.

– **Animated Points**: This setting allows the radial curves in the spline area to be animated over time. Once this option is selected, moving to the desired frame and making a change in the Spline Editor sets a keyframe.

– The Interpolated Values option is mostly obsolete and is included for compatibility reasons only.

### Radial Length and Radial Density Splines

The Spline window shows curves for the Length and Density of the hot spot. It is a miniature Spline Editor. The key to these splines is realizing that the horizontal axis in Inspector’s Spline Editor represents a position around the circumference of the hot spot. A value of 0.0 is 0 degrees, and 1.0 is 360 degrees. With that in mind, the length determines the radius of light making up the hot spot along the circumference. The density represents how bright the light is along the circumference.

### Radial Repeat

This control repeats the effect of the radial splines by x number of times. For example, a repeat of 2.0 causes the spline to take effect between 0 and 180 degrees instead of 0 and 360, repeating the spline between 180 and 360.

### Length Angle

This control rotates the effect of the Radial Length spline around the circumference of the hot spot.

### Density Angle

This control rotates the effect of the Radial Density spline around the circumference of the hot spot.

**NOTE:** Right-clicking in the spline area displays a contextual menu containing options related to modifying spline curves.

A complete description of LUT Editor controls and options can be found in Chapter 45, “LUT Nodes.”

### L1, L2, and L3 Tab

![Image of L1, L2, and L3 Tab controls](image-url)
Lens Reflect Tabs
The three Lens Reflect tabs are used to enable and design additional lens flare elements beyond the primary and secondary hot spots.

Lens Reflect 1-3
Each of these three checkboxes enables a pair of lens reflection elements that you can modify using the controls in this tab. The parameters affect all the enabled Lens reflection elements in this tab.

Element Strength
This determines the brightness of element reflections.

Element Size
This determines the size of element reflections.

Element Position
This determines the distance of element reflections from the axis. The axis is calculated as a line between the hot spot position and the center of the image.

Element Type
Use this group of buttons to choose the shape and density of the element reflections. The presets available are described below.

- Circular: This creates slightly soft-edged circular shaped reflections.
- Soft Circular: This creates very soft-edged circular shaped reflections.
- Circle: This creates a hard-edged circle shape.
- NGon Solid: This creates a filled polygon with a variable number of sides.
- NGon Star: This creates a very soft-edged star shape with a variable number of sides.
- NGon Shaded Out: This creates soft-edged circular shapes.
- NGon Shaded In: This creates a polygon with a variable number of sides, which has a very soft reversed (dark center, bright radius) circle.

NGon Angle:
This control is used to determine the angle of the NGon shapes.

NGon Sides:
This control is used to determine the number of sides used when the Element Type is set to Ngon Star, Ngon Shaded Out, and Ngon Shaded In.

NGon Starriness:
This control is used to bend polygons into star shapes. The higher the value, the more star-like the shape.

Lens Color Controls
These controls determine the color of the lens that affects the colors of the reflections. To choose a lens color, pick one from a displayed image or enter RGBA values using the sliders or input boxes.

Common Controls

Settings Tab
The Settings tab controls are common to all Effect nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.
Pseudo Color [PSCL]

The Pseudo Color node provides the ability to produce variations of an image’s color based on waveforms generated by the node’s controls. Static or animated variances of the original image can be produced.

**Inputs**

There are two Inputs on the Pseudo Color node: one for an image and one for an effects mask.

- **Input:** The orange input is used for the primary 2D image that gets its color modified.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input restricts the pseudo color to be within the pixels of the mask. An effects mask is applied to the tool after the tool is processed.

**Basic Node Setup**

The Pseudo Color node is not a stand-alone generator, so it must have an image input that it uses to generate variations in colors.

**Inspector**

The Pseudo Color RGBA controls are used to adjust the color variations. The controls include options for red, green, blue, and alpha channels, as well as waveforms, frequency, phase, and amplitude settings.
**Red/Green/Blue/Alpha Tabs**
The node's controls are separated into four identical tabs, one for each of the RGBA color channels.

**Color Checkbox**
When enabled, the Pseudo Color node affects this color channel.

**Wrap**
When enabled, waveform values that exceed allowable parameter values are wrapped to the opposite extreme.

**High and Low**
High and Low determine the range to be affected by the node in a specific color channel.

**Soft Edge**
This slider determines the soft edge of color transition.

**Waveform**
This selects the type of waveform to be created by the generator. Four waveforms are available: Sine, Triangle, Sawtooth, and Square.

**Frequency**
This controls the frequency of the waveform selected. Higher values increase the number of occurrences of the variances.

**Phase**
This modifies the Phase of the waveform. Animating this control produces color cycling effects.

**Mean**
This determines the level of the waveform selected. Higher values increase the overall brightness of the channel until the allowed maximum is reached.

**Amplitude**
Amplitude increases or decreases the overall power of the waveform.

**Common Controls**

**Settings Tab**
The Settings tab controls are common to all Effect nodes, so their descriptions can be found in "The Common Controls" section at the end of this chapter.

---

**Rays [CIR]**

The Rays node

---

**Rays Node Introduction**
Rays is a modified zoom blur effect that radiates through an object from a specified point.
**Inputs**

There are two inputs on the Rays node: one for the image and one for the effects mask:

- **Input:** The orange input is used for the primary 2D image that gets the rays applied to it.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input restricts the rays to be within the pixels of the mask. An effects mask is applied to the tool after the tool is processed.

**Basic Node Setup**

The Rays node works best when the image or graphic connected to the orange input includes an Alpha channel from which the rays emit.

**Inspector**

![Rays node controls](image)

**Controls Tab**

The Controls tab contains all the primary controls necessary for customizing the rays.

- **Center X and Y**
  This coordinate control and related viewer crosshair set the center point for the light source.

- **Blend**
  Sets the percentage of the original image that’s blended with the light rays.

- **Decay**
  Sets the length of the light rays.

- **Weight**
  Sets the falloff of the light rays.

- **Exposure**
  Sets the intensity level of the light rays.

- **Threshold**
  Sets the luminance limit at which the light rays are produced.
Common Controls

Settings Tab
The Settings tab controls are common to all Effect nodes, so their descriptions can be found in the “The Common Controls” section at the end of this chapter.

Shadow [SH]

The Shadow node

Shadow Node Introduction
Shadow is a versatile node used in the creation of a drop shadow, based on the Alpha channel in an image. Optionally, a second image can be used as a depth matte to distort the shadow based on the varying depth in a background image.

Input
The three inputs on the Shadow node are used to connect a 2D image that causes the shadow. A depth map input and an effect mask can be used to limit the area where trails appear. Typically, the output of the shadow is then merged over the actual background in the composite.

– **Input**: The orange input is used for the primary 2D image with Alpha channel that is the source of the shadow.

– **Depth**: The green Depth map input takes a 2D image as its input and extracts a depth matte from a selected channel. The light Position and Distance controls can then be used to modify the appearance of the shadow based on depth.

– **Effect Mask**: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the area where the shadow appears. An effects mask is applied to the tool after the tool is processed.

**NOTE**: The Shadow node is designed to create simple 2D drop shadows. Use a Spot Light node and an Image Plane 3D node for full 3D shadow casting.

Basic Node Setup
Below, the Shadow node uses the output of an image with Alpha and connects to the foreground of a Merge. The shadow is shown over the background input to the Merge.
A Shadow node is generated from the MediaIn2 and shown over MediaIn1.

**Inspector**

**Shadow node controls**

**Controls Tab**
The Controls tab contains all the primary controls necessary for customizing the shadow appearance.

**Shadow Offset**
This control sets the X and Y position of the shadow. When the Shadow node is selected, you can also adjust the position of the Shadow Offset using the crosshair in the viewer.

**Softness**
Softness controls how blurry the shadow’s edges appear.

**Shadow Color**
Use this control to select the color of the shadow. The most realistic shadows are usually not totally black and razor sharp.

**Light Position**
This control sets the position of the light relative to the shadow-casting object. The Light Position is only taken into consideration when the Light Distance slider is not set to infinity (1.0).
**Light Distance**
This slider varies the apparent distance of the light between infinity (1.0) and zero distance from the shadow-casting object. The advantage of setting the Light Distance is that the resulting shadow is more realistic-looking, with the further parts of the shadow being longer than those that are closer.

**Minimum Depth Map Light Distance**
This control is active when an image is connected to the shadow’s Depth Map input. The slider is used to control the amount that the depth map contributes to the Light Distance. Dark areas of a depth map make the shadow deeper. White areas bring it closer to the camera.

**Z Map Channel**
This menu is used to select which color channel of the image connected to the node’s Depth Map input is used to create the shadow’s depth map. Selections exist for the RGB and A, Luminance, and Z-buffer channels.

**Output**
This menu determines if the output image contains the image with shadow applied or the shadow only. The shadow only method is useful when color correction, perspective, or other effects need to be applied to the resulting shadow before it is merged back with the object.

**Common Controls**

**Settings Tab**
The Settings tab controls are common to all Effect nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.

---

**Trails [TRLS]**

![The Trails node](image)

**Trails Node Introduction**
The Trails node is used to create a ghost-like after-trail of the image. This creates an interesting effect when applied to moving images with an Alpha channel. Unlike a directional blur, only the preceding motion of an image is displayed as part of the effect. Since the trail effect is based on an image buffer, it requires you to play or activate the pre-roll for some number of frames before you see the effect.

**Input**
The two inputs on the Trails node are used to connect a 2D image and an effect mask that can be used to limit the area where trails appear.

- **Input:** The orange input is used for the primary 2D image that receives the trails applied.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the area where the trails effect appears. An effects mask is applied to the tool after the tool is processed.
Basic Node Setup

The output of an animated Text node is connected to the input of the Trails node. Trails are generated based on the motion of the text. The Reset button must be pressed in the Inspector between each preview, or the trails will accumulate.

![Image of Basic Node Setup](image)

A Trails node generates trails for the animation in the Text node.

Inspector

![Image of Trails Node Inspector](image)

Controls Tab

The Controls tab contains all the primary controls necessary for customizing the trails.

**Restart**

This control clears the image buffer and displays a clean frame, without any of the ghosting effects.

**Preroll**

This makes the Trails node pre-render the effect by the number of frames on the slider.

**Reset/Preroll on Render**

When this checkbox is enabled, the Trails node resets itself when a preview or final render is initiated. It pre-rolls the designated number of frames.

**This Time Only**

Selecting this checkbox makes the pre-roll use this current frame only and not the previous frames.
**Preroll Frames**
This determines the number of frames to pre-roll.

**Lock RGBA**
When selected, this checkbox allows the Gain of the color channels to be controlled independently. This allows for tinting of the Trails effect.

**Gain**
The Gain control affects the overall intensity and brightness of the image in the buffer. Lower values in this parameter create a much shorter, fainter trail, whereas higher values create a longer, more solid trail.

**Rotate**
The Rotate control rotates the image in the buffer before the current frame is merged into the effect. The offset is compounded between each element of the trail. This is different than each element of the trail rotating on its pivot point. The pivot remains over the original object.

**Offset X/Y**
These controls offset the image in the buffer before the current frame is merged into the effect. Control is given over each axis independently. The offset is compounded between each element of the trail.

**Lock Scale X/Y**
When selected, this checkbox allows the X- and Y-axis scaling of the image buffer to be manipulated separately for each axis.

**Scale**
The Scale control resizes the image in the buffer before the current frame is merged into the effect. The size is compounded between each element of the trail.

**Lock Blur X/Y**
When selected, this checkbox allows the blurring of the image buffer to be controlled separately for each axis.

**Blur Size**
The Blur Size control applies a blur to the trails in the buffer before the current frame is merged into the effect. The blur is compounded between each element of the trail.

**Apply Mode**
The Apply Mode setting determines the math used when blending or combining the trailing objects that overlap.

- **Normal**: The default mode uses the foreground object’s Alpha channel as a mask to determine which pixels are transparent and which are not. When this is active, another menu shows possible operations, including Over, In, Held Out, Atop, and XOr.
- **Screen**: Screen blends the objects based on a multiplication of their color values. The Alpha channel is ignored, and layer order becomes irrelevant. The resulting color is always lighter. Screening with black leaves the color unchanged, whereas screening with white always produces white. This effect creates a similar look to projecting several film frames onto the same surface. When this is active, another menu shows possible operations, including Over, In, Held Out, Atop, and XOr.
- **Dissolve**: Dissolve mixes overlapping objects. It uses a calculated average of the objects to perform the mixture.
– **Multiply:** Multiplies the values of a color channel. This gives the appearance of darkening the object as the values are scaled from 0 to 1. White has a value of 1, so the result would be the same. Gray has a value of 0.5, so the result would be a darker object or, in other words, an object half as bright.

– **Overlay:** Overlay multiplies or screens the color values of the foreground object, depending on the color values of the background object. Patterns or colors overlay the existing pixels while preserving the highlights and shadows of the color values of the objects behind the foreground objects. The objects behind the foreground objects are not replaced but mixed with the foreground objects to reflect the original lightness or darkness of the background objects.

– **Soft Light:** Soft Light darkens or lightens the foreground object, depending on the color values of the objects behind them. The effect is similar to shining a diffused spotlight on the image.

– **Hard Light:** Hard Light multiplies or screens the color values of the foreground object, depending on the color values of the objects behind them. The effect is similar to shining a harsh spotlight on the image.

– **Color Dodge:** Color Dodge uses the foreground object’s color values to brighten the objects behind them. This is similar to the photographic practice of dodging by reducing the exposure of an area of a print.

– **Color Burn:** Color Burn uses the foreground object’s color values to darken the objects behind them. This is similar to the photographic practice of burning by increasing the exposure of an area of a print.

– **Darken:** Darken looks at the color information in each channel and selects the color value from the object in front or behind, whichever is darker. Pixels lighter than the blended colors are replaced, and pixels darker than the blended color do not change.

– **Lighten:** Lighten looks at the color information in each channel and selects the color value from the object in front or behind, whichever is lighter. Pixels darker than the blended color are replaced, and pixels lighter than the blended color do not change.

– **Difference:** Difference looks at the color information in each channel and subtracts the foreground object’s color values from the background object’s color values or vice versa, depending on which has the higher brightness value. Blending with white inverts the color. Blending with black produces no change.

– **Exclusion:** Exclusion creates an effect similar to but lower in contrast than the Difference mode. Blending with white inverts the base color values. Blending with black produces no change.

– **Hue:** Hue creates color with the luminance and saturation of the background object’s color and the hue of the foreground object’s color.

– **Saturation:** Saturation creates color with the luminance and hue of the base color and the saturation of the blend color.

– **Color:** Color creates color with the luminance of the background object’s color and the hue and saturation of the object in front. This preserves the gray levels in the image and is useful for colorizing monochrome objects.

– **Luminosity:** Luminosity creates color with the hue and saturation of the background object’s color and the luminance of the foreground object’s color. This mode creates an inverse effect from that of the Color mode.

**Operator**

This menu is used to select the Operation mode used when the trailing objects overlap. Changing the Operation mode changes how the overlapping objects are combined to produce a result. This drop-down menu is visible only when the Apply mode is set to Normal.

The formula used to combine pixels in the trails node is always \((\text{fg object} \times x) + (\text{bg object} \times y)\). The different operations determine what \(x\) and \(y\) are, as shown in the description for each mode.
The Operator Modes are as follows:

- **Over**: The Over mode adds the foreground object to the background object by replacing the pixels in the background with the pixels from the Z wherever the foreground object’s Alpha channel is greater than 1.
  
  \[ x = 1, \ y = 1 - [\text{foreground object Alpha}] \]

- **In**: The In mode multiplies the Alpha channel of the background object against the pixels in the foreground object. The color channels of the foreground object are ignored. Only pixels from the foreground object are seen in the final output. This essentially clips the foreground object using the mask from the background object.
  
  \[ x = [\text{background Alpha}], \ y = 0 \]

- **Held Out**: Held Out is essentially the opposite of the In operation. The pixels in the foreground object are multiplied against the inverted Alpha channel of the background object.
  
  \[ x = 1 - [\text{background Alpha}], \ y = 0 \]

- **Atop**: Atop places the foreground object over the background object only where the background object has a matte.
  
  \[ x = [\text{background Alpha}], \ y = 1 - [\text{foreground Alpha}] \]

- **XOr**: XOr combines the foreground object with the background object wherever either the foreground or the background have a matte, but never where both have a matte.
  
  \[ x = 1 - [\text{background Alpha}], \ y = 1 - [\text{foreground Alpha}] \]

### Subtractive/Additive

This slider controls whether Fusion performs an Additive composite, a Subtractive composite, or a blend of both when the trailing objects overlap. This slider defaults to Additive assuming the input image’s Alpha channel is premultiplied (which is usually the case). If you don’t understand the difference between Additive and Subtractive compositing, below is a quick explanation.

**NOTE**: An Additive blend operation is necessary when the foreground image is premultiplied, meaning that the pixels in the color channels have been multiplied by the pixels in the Alpha channel. The result is that transparent pixels are always black since any number multiplied by 0 always equals 0. This obscures the background (by multiplying with the inverse of the foreground Alpha), and then adds the pixels from the foreground.

A Subtractive blend operation is necessary if the foreground image is not premultiplied. The compositing method is similar to an additive composite, but the foreground image is first multiplied by its Alpha, to eliminate any background pixels outside the Alpha area.

Although the Additive/Subtractive option is often an either/or checkbox in other software, the Trails node lets you blend between the Additive and Subtractive versions of the compositing operation. This can be useful when dealing with problem edges that are too bright or too dark.

For example, using Subtractive merging on a premultiplied image may result in darker edges, whereas using Additive merging with a non-premultiplied image causes any non-black area outside the foreground’s Alpha to be added to the result, thereby lightening the edges. By blending between Additive and Subtractive, you can tweak the edge brightness to be just right for your situation.
**Alpha Gain**

Alpha Gain linearly scales the Alpha channel values of the trailing objects in front. This effectively reduces the amount that the trailing objects in the background are obscured, thus brightening the overall result. When the Subtractive/Additive slider is set to Additive with Alpha Gain set to 0.0, the foreground pixels are added to the background.

When the Subtractive/Additive slider is set to Subtractive, this controls the density of the composite, similar to Blend.

**Burn In**

The Burn In control adjusts the amount of Alpha used to darken the objects that trail under other objects, without affecting the amount of foreground objects added. At 0.0, the blending behaves like a straight Alpha blend. At 1.0, the objects in the front are effectively added onto the objects in the back (after Alpha multiplication if in Subtractive mode). This gives the effect of the foreground objects brightening the objects in the back, as with Alpha Gain. In fact, for Additive blends, increasing the Burn In gives an identical result to decreasing Alpha Gain.

**Merge Under**

When enabled, the current image is placed under the generated trail, rather than the usual, over top operation. The layer order of the trailing elements is also reversed, making the last trail the topmost layer.

**Common Controls**

**Settings Tab**

The Settings tab controls are common to all Effect nodes, so their descriptions can be found in "The Common Controls" section at the end of this chapter.

---

**TV [TV]**

The TV node

**TV Node Introduction**

The TV node is a simple node designed to mimic some of the typical flaws seen in analog television broadcasts and screens. This Fusion-specific node is mostly obsolete when using DaVinci Resolve because of the more advanced Analog Damage ResolveFX.

**Input**

The two inputs on the TV node are used to connect a 2D image and an effect mask, which can be used to limit the area where the TV effect appears.

- **Input:** The orange input is used for the primary 2D image that gets the TV distortion applied.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the area where the the TV effect to appears. An effects mask is applied to the tool after the tool is processed.
Basic Node Setup

The output of an image is connected to the input of the TV node. The style of TV interference is then customized using the controls in the Inspector.

Inspector

Controls Tab

The Controls tab is the first of three tabs used to customize the analog TV distortion. The Controls tab modifies the scan lines and image distortion of the effect.

Scan Lines

This slider is used to emulate the interlaced look by dropping lines out of the image. Setting it to black, with a transparent Alpha, drops a line. A value of 1 (default) drops every second line. A value of 2 shows one line, and then drops the second and third and repeats. A value of zero turns off the effect.

Horizontal

Use this slider to apply a simple Horizontal offset to the image.

Vertical

Use this slider to apply a simple Vertical offset to the image.

Skew

This slider is used to apply a diagonal offset to the image. Positive values skew the image to the top left. Negative values skew the image to the top right. Pixels pushed off frame wrap around and reappear on the other side of the image.

Amplitude

The Amplitude slider can be used to introduce smooth sine wave-type deformation to the edges of the image. Higher values increase the intensity of the deformation. Use the Frequency control to determine how often the distortion is repeated.
**Frequency**
The Frequency slider sets the frequency of the sine wave used to produce distortion along the edges of the image when the amplitude control is greater than 1.

**Offset**
Use Offset to adjust the position of the sine wave, causing the deformation applied to the image via the Amplitude and Frequency controls to see across the image.

The TV Noise tab

**Noise Tab**
The Noise tab is the second of three tabs used to customize the analog TV distortion. The Noise tab modifies the noise in the image to simulate a weak analog antenna signal.

**Power**
Increase the value of this slider above 0 to introduce noise into the image. The higher the value, the stronger the noise.

**Size**
Use this slider to scale the noise map larger.

**Random**
If this thumbwheel control is set to 0, the noise map is static. Change the value over time to cause the static to change from frame to frame.

The TV Roll Bar tab

**Roll Bar Tab**
The Roll Bar tab is the third of three tabs used to customize the analog TV distortion. The Roll Bar tab animates the bar.

**Bar Strength**
At the default value of 0, no bar is drawn. The higher the value, the darker the area covered by the bar becomes.

**Bar Size**
Increase the value of this slider to make the bar taller.
Bar Offset
Animate this control to scroll the bar across the screen.

Common Controls

Settings Tab
The Settings tab controls are common to all Effect nodes, so their descriptions can be found in the following “The Common Controls” section.

The Common Controls
Effect nodes share several identical controls in the Inspector. This section describes controls that are common among Effect nodes.

Inspector

Settings Tab
The Settings tab in the Inspector can be found on every tool in the Effects category. The Settings controls are even found on third-party Effects-type plug-in tools. The controls are consistent and work the same way for each tool, although some tools do include one or two individual options, which are also covered here.
Blend
The Blend control is used to blend between the tool's original image input and the tool's final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming image. This causes the tool to skip processing entirely, copying the input straight to the output.

Process When Blend Is 0.0
The tool is processed even when the input value is zero. This is useful when this node is scripted to trigger another task, but the blend is set to 0.0.

Red/Green/Blue/Alpha Channel Selector
These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.

For example, if the red button on a Blur tool is deselected, the blur is first applied to the image, and then the red channel from the original input is copied back over the red channel of the result.

There are some exceptions, such as tools for which deselecting these channels causes the tool to skip processing that channel entirely. Tools that do this possess a set of like RGBA buttons on the Controls tab in the tool. In this case, the buttons in the Settings and the Control tabs are identical.

Apply Mask Inverted
Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

Multiply by Mask
Selecting this option causes the RGB values of the masked image to be multiplied by the mask channel's values. This causes all pixels of the image not included in the mask (i.e., set to 0) to become black/transparent.

Use Object/Use Material (Checkboxes)
Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports Object and Material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels are used, if present. The specific Material ID or Object ID affected is chosen using the next set of controls.

Correct Edges
This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option is disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information on Coverage and Background Color channels, see Chapter 18, “Understanding Image Channels” in the Fusion Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.

Object ID/Material ID (Sliders)
Use these sliders to select which ID is used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker: to grab IDs from the image displayed in the view. The image or sequence must have been rendered from a 3D software package with those channels included.
Clipping Mode
This option determines how the domain of definition rendering handles edges. The Clipping mode is most important when blur or softness is applied, which may require samples from portions of the image outside the current domain.

- **Frame:** The default option is Frame, which automatically sets the node’s domain of definition to use the full frame of the image, effectively ignoring the current domain of definition. If the upstream DoD is smaller than the frame, the remaining area in the frame is treated as black/transparent.

- **None:** Setting this option to None does not perform any source image clipping. Any data required to process the node’s effect that would usually be outside the upstream DoD is treated as black/transparent.

Use GPU
The Use GPU menu has three settings. Setting the menu to Disable turns off hardware-accelerated rendering using the graphics card in your computer. Enabled uses the hardware. Auto uses a capable GPU if one is available and falls back to software rendering when a capable GPU is not available.

Motion Blur
- **Motion Blur:** This toggles the rendering of Motion Blur on the tool. When this control is toggled on, the tool’s predicted motion is used to produce the motion blur caused by the virtual camera’s shutter. When the control is toggled off, no motion blur is created.

- **Quality:** Quality determines the number of samples used to create the blur. A quality setting of 2 causes Fusion to create two samples to either side of an object’s actual motion. Larger values produce smoother results but increase the render time.

- **Shutter Angle:** Shutter Angle controls the angle of the virtual shutter used to produce the motion blur effect. Larger angles create more blur but increase the render times. A value of 360 is the equivalent of having the shutter open for one full frame exposure. Higher values are possible and can be used to create interesting effects.

- **Center Bias:** Center Bias modifies the position of the center of the motion blur. This allows for the creation of motion trail effects.

- **Sample Spread:** Adjusting this control modifies the weighting given to each sample. This affects the brightness of the samples.

Comments
The Comments field is used to add notes to a tool. Click in the empty field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

Scripts
Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
Chapter 99

Film Nodes

This chapter details the Film nodes in Fusion.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

Cineon Log [LOG] 1934
Film Grain [FGR] 1937
Grain [GRN] 1940
Light Trim [LT] 1943
Remove Noise [RN] 1945
The Common Controls 1947
Cineon Log [LOG]

The Cineon Log node

Cineon Log Node Introduction

The Cineon Log node is used to convert several different log camera formats to linear gamma and back again. Although the name implies that it should be used with Cineon files, it handles “log” gamma from many different digital cinema sources such as Blackmagic Design, Arri, and Red cameras.

Input

There are two Inputs on the Cineon Log node: one for the log image and one for the effects mask.

- **Input:** The orange input is used for the primary 2D image that gets the highlight applied.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input restricts the log conversion to be within the pixels of the mask. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

The Cineon Log node is placed directly after a MediaIn node in DaVinci Resolve or a Loader node in Fusion Studio. It is also commonly placed before a MediaOut or Saver node to convert back to a Log-encoded image.

A Cineon Log node placed after a Loader node in Fusion Studio

Inspector

Cineon Log controls
Controls Tab
The Controls tab includes settings for converting from log gamma to linear or from linear to log. You first select the Mode and then the Log Type. For instance, choose Log to Lin from the Mode menu, and then select BMD Film if you are compositing with a RAW clip from a Blackmagic Design camera. Those settings output a linear image ready for compositing.

Depth
The Depth menu is used to select the color depth used to process the input image. The default option is Auto. Auto determines the color depth based on the file format loaded. For example, JPEG files automatically process at 8 bit because the JPEG file format does not store color depths greater than 8. Blackmagic RAW files load at Float, etc. If the color depth of the format is undetermined, the default depth defined in the Frame Format preferences is used.

Mode
The Mode menu offers two options: one for converting log images to linear and one for converting linear images to logarithmic.

Log Type
The Log Type menu allows you to select the source of the file. Typically, you select the camera used to create the image, although the Josh Pines option is specific to film scan workflows. This menu contains the following camera log types:

- Cineon
- Arri Log C
- BMD Film
- Canon Log
- Nikon N Log
- Panalog
- Panasonic V-Log
- Red Log Film
- Sony S-Log
- Viper Film Stream
- ACESlog

Lock RGB
When enabled, the settings in this tab affect all color channels equally. Disable this control to convert the red, green, and blue channels of the image using separate settings for each channel.

Level
Use this range control to set the black level and white level in the log image before converting. The left handle adjusts the black level, while the right handle adjusts the white level. Pixels with values in log space below the black level become out-of-range values below 0.0. Pixels with values above the white level become out-of-range values above 1.0 after conversion.

When processing in floating-point color space, both negative and high out-of-range values are preserved. When using 16-bit or 8-bit mode, the out-of-range values are clipped.

Soft Clip (Knee)
The Soft Clip control is used to draw values that are out of range back into the image. This is done by smoothing the conversion curve at the top and bottom of the curve, allowing more values to be represented.

Applying a soft clip of any value other than 1 causes the node to process at 16-bit integer, eliminating all out-of-range values that do not fit within the soft clip.

Film Stock Gamma, Conversion Gamma, and Conversion Table
These controls are used to set the response curves of the logarithmic data during conversion. In addition to the settings above, a custom ASCII file Lookup Table (LUT) can be created with specific conversion values. The ASCII LUT file can be loaded using the Browse button.
Common Controls

Settings Tab
The Settings tab controls are common to all Film nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.

Black Rolloff
Since a mathematical log() operation on a value of zero or lower results in invalid values, Fusion clips values below $1e^{-38}$ (0 followed by 38 zeros) to 0 to ensure correct results. This is almost never an issue, since values that small have no visual impact on an image. To see such tiny values, you would have to add three Brightness Contrast nodes, each with a gain set to 1,000,000. Even then, the values would hover very close to zero.

We have seen processes where instead of cropping these minimal values, they are instead scaled. So values between 0.0 and $1e^{-16}$ are scaled between $1e^{-18}$ and $1e^{-16}$. The idea is to crush the majority of the visual range in a float image into values very near to zero, then expand them again, forcing a gentle ramp to produce a small ramp in the extreme black values. Should you find yourself facing a color pipeline using this process, here is how you can mimic it with the help of a Custom node.

The process involves converting the log image to linear with a very small gamma and a wider than normal black level to white level (e.g., conversion gamma of 0.6, black of 10, white of 1010). This crushes most of the image's range into very small values. This is followed by a Custom node (described below), and then by a linear to log conversion that reverses the process but uses a slightly higher black level. The difference between the black levels defines the falloff range.

Since this lifts the blacks, the image is usually then converted back to linear one more time, using more traditional values (i.e., 95-685) to reset the black point.

The Custom node should use the following equation in the red, green, and blue expressions:

$$\text{if } (c1 < 1e^{-16}, 1e^{-18} + (c1/1e^{-16}) \times (1e^{-16} - 1e^{-18}), c1)$$

Falloff Comparison

The black falloff from the native Fusion process

Virtually identical black falloff from the ramped clipping process
**Film Grain [FGR]**

The Film Grain node adds generated film grain to an image. Typically, when compositing with different elements shot on film and in digital, the grain is removed for compositing operations and then reapplied to the final composite. This helps create the appearance that all elements were shot as a single scene with the same film stock.

**NOTE:** Although more accurate, the Film Grain node does not replace the older Grain node, which is still provided to allow older compositions to load and render, but in almost every case, it is better to use the Film Grain node.

**Input**

There are two inputs on the Film Grain node: one for the image and one for the effects mask.

- **Input:** The orange input is used for the primary 2D image that gets the grain applied.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the grain to be within the pixels of the mask. An effects mask is applied to the tool after the tool is processed.

**Basic Node Setup**

The Film Grain node is commonly used before a MediaOut node in DaVinci Resolve or before a Saver node in Fusion Studio. Since grain is often removed from source material to achieve cleaner keys and composite, film grain is added back before the output to create a more realistic composite.
Inspector

Controls Tab
The Controls tab includes all the parameters for modifying the appearance of the film grain.

Complexity
The Complexity setting indicates the number of “layers” of grain applied to the image. With a complexity of 1, only one grain layer is calculated and applied to the image. When complexity is set to 4, the node calculates four separate grain layers and applies the mean combined result of each pass to the final image. Higher complexities produce visually more sophisticated results, without the apparent regularity often perceivable in digitally-produced grain.

Alpha Multiply
When the Alpha Multiply checkbox is enabled, the Film Grain node multiplies its results by the source image’s Alpha channel. This is necessary when working with post-multiplied images to ensure that the grain does not affect areas of the image where the Alpha is 0.0 (transparent).

**NOTE:** Since it is impossible to say what the final value of semitransparent pixels in the image are until after they are composited with their background, you should avoid applying log-processed grain to the elements until after they have been composited. This ensures that the strength of the grain is accurate.

Log Processing
When this checkbox is enabled (default), the grain applied to the image has its intensity applied nonlinearly to match the grain profile of most film. Roughly speaking, the intensity of the grain increases exponentially from black to white. When this checkbox is disabled, the grain is applied uniformly, regardless of the brightness of the affected pixel.

One of the primary features of grain in film is that the appearance of the grain varies radically with the exposure so that there appears to be minimal grain present in the blacks, with the amount and deviation of the grain increasing as the pixels exposure increases. In a film negative, the darkest portions of the developed image appear entirely opaque, and this obscures the grain. As the negative becomes progressively clearer, more of the grain becomes evident in the result. Chemical differences in the R, G, B, layer’s response to light also cause each color component of the film to present a different grain profile, typically with the blue channel presenting the most significant amount of grain.
As a result, an essential control in the Film Grain node is the Log Processing checkbox, which should be enabled when matching film, and disabled when working with images that require a more linear grain response. Having this checkbox enabled closely mimics the results of preceding the old Grain node with a Linear to Log conversion and following with a Log to Linear conversion immediately after.

**Seed**

The Seed slider and Reseed button are presented whenever a Fusion node relies on a random result. Two nodes with the same seed values produce the same random results. Click on the Reseed button to randomly select a new seed value, or adjust the slider to select a new seed value manually.

**Time Lock**

Enabling Time Lock stops the random seed from generating new grain on every frame.

**Monochrome**

When the Monochrome checkbox is enabled (default), the grain is applied to the red, green, and blue color channels of the image equally. When deselected, individual control over the Size, Strength, and Roughness of the grain in each channel becomes possible.

**Lock Size X/Y**

Deselect the Lock Size X/Y checkbox to control the size of the grain along the X- and Y-axis individually.

**Size**

The grain size is calculated relative to the size of a pixel. Consequently, changing the resolution of the image does not impact the relative appearance of the grain. The default grain size of 1.0 produces grain kernels that cover roughly 2 pixels.

**Strength**

Grain is expressed as a variation from the original color of a pixel. The stronger the grain’s strength, the wider the possible variation from the original pixel value. For example, given a pixel with an original value of \( p \), and a Grain node with complexity = 1 size = 1; roughness = 0; log processing = off; the grain produces an output value of \( p \pm \text{strength} \). In other words, a pixel with a value of 0.5 with a grain strength of 0.02 could end up with a final value between 0.48 and 0.52.

Once again, that’s a slight oversimplification, especially when the complexity exceeds 1. Enabling the Log Processing checkbox also causes that variation to be affected such that there is less variation in the blacks and more variation in the whites of the image.

**NOTE:** When visualizing the effect of the grain on the image, the more mathematically inclined may find it helps to picture a sine wave, where each lobe of the sine wave covers 1 pixel when the Grain Size is 1.0. The Grain Size controls the frequency of the sine wave, while the Grain Strength controls its amplitude. Again, this is something of an oversimplification.

**Roughness**

The Roughness slider applies low frequency variation to give the impression of clumping in the grain. Try setting the roughness to 0, and observe that the grain produced has a very even luminance variation across the whole image. Increase the roughness to 1.0 and observe the presence of "cellular" differences in the luminance variation.

**Offset**

The Offset control helps to match the intensity of the grain in the deep blacks by offsetting the values before the intensity (strength) of the grain is calculated. So an offset of 0.1 would cause a pixel with a value of 0.1 to receive grain as if its value was 0.2.
Common Controls

Settings Tab
The Settings tab controls are common to all Film nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.

Processing Examples

Log Processing On

In the default setting, the different amounts of Grain are applied to the blacks and the whites of the image.

Log Processing Off

When Log processing is off, the Grain is applied evenly to the entire image, as shown here.

Grain [GRN]

The Grain node

Grain Node Introduction
The Grain node offers an older film grain emulation than the more modern and accurate Film Grain node. The Grain node is still provided to allow older compositions to load and render, but in almost every case, it is better to use the Film Grain node.
**Input**

There are two Inputs on the Grain node: one for the 2D image and one for the effects mask.

- **Input**: The orange input is used for the primary 2D image that gets the grain applied.
- **Effect Mask**: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the grain to be within the pixels of the mask. An effects mask is applied to the tool after the tool is processed.

**Basic Node Setup**

The Grain node is commonly placed before a MediaOut node in DaVinci Resolve, or before a Saver node in Fusion Studio. It adds back grain previously removed in a composite.

![A Grain node used to add grain back for a more realistic composite](image)

**Inspector**

**Controls Tab**

The Controls tab includes all the parameters for modifying the appearance of the grain.

**Power**

This slider determines the strength of the grain. A higher value increases visibility, making the grain more prevalent.

**RGB Difference**

Separate Red, Green, and Blue sliders are used to modify the strength of the effect on a per channel basis.
Grain Softness
This slider controls the blurriness or fuzziness of the grain. Smaller values cause the grain to be more sharp or coarse.

Grain Size
This slider determines the size of the grain particles. Higher values increase the grain size.

Grain Spacing
This slider determines the density or amount of grain per area. Higher values cause the grain to appear more spaced out.

Aspect Ratio
This slider adjusts the aspect of the grain so that it can be matched with anamorphic images.

Alpha-Multiply
When enabled, this checkbox multiplies the image by the Alpha, clearing the black areas of any grain effect.

Spread Tab
The Spread tab uses curves for the red, green, and blue channels to control the amount of grain over each channel’s tonal range.

RGB Checkboxes
The red, green, and blue checkboxes enable each channel’s custom curve, allowing you to control how much grain appears in each channel. To mimic usual film responses, more grain would appear in the blue channel than the red, and the green channel would receive the least. Right-clicking in the spline area displays a contextual menu containing options related to modifying spline curves.

In and Out
This control provides direct editing of points on the curve by setting In/Out point values.
Examples

Default Spread
In the default setting, the grain is applied evenly to the entire image, as shown here. However, film often shows a different amount of grain in the blacks, mids, and whites.

Bell-Shaped Spread
Setting a bell shape is often a good starting point to create a more realistic-looking grain. Here we have a non-uniform distribution with different amounts of grain in the red, green, and blue channels.

In both examples, the grain's power has been exaggerated to show the effect a bit better.

Common Controls

Setting Tab
The Settings tab controls are common to all Film nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.

Light Trim [LT]
Light Trim Node Introduction

This node emulates film scanner light trims. By design, this node works best with logarithmic data, such as the images stored by Cineon, Arri, or Blackmagic RAW files. When logarithmic data is provided, the Light Trim node can be used to increase or decrease the apparent exposure level of the image.

Inputs

There are two inputs on the Light Trim node: one for the 2D image and one for the effects mask.

- **Input**: The orange input is used for the primary Log 2D image that gets its exposure adjusted.
- **Effect Mask**: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the exposure change to be within the pixels of the mask. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

The Light Trim node is placed after a LOG clip but before the Log clip is converted by a Cineon LOG node.

![A Light Trim node used to adjust exposure on a LOG clip](image)

Inspector

Light Trim controls

Controls Tab

The Controls tab includes a single slider that adjusts the exposure of the image.

**Lock RGBA**

When selected, the Lock RGBA control collapses control of all image channels into one slider. This selection is on by default. To manipulate the various color channels independently, deselect this checkbox.

**Trim**

This slider shifts the color in film, optical printing, and lab printing points. 8 points equals one stop of exposure.
Common Controls

Settings Tab
The Settings tab controls are common to all Film nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.

Remove Noise [RN]

The Remove Noise node provides simple noise management. The basic operation is that the node blurs the image channels, and then compares the blurred image to the original to extract the noise. A sharpness is then applied to the image, except where noise was detected.

To use this node, view the image and look at the red channel. Then increase the Red Softness until the grain appears to be gone. Next, increase the sharpness until the detail reappears, but stop before the grain reappears. Repeat for the green and blue channels.

Inputs
There are two inputs on the Remove Noise node: one for the 2D image and one for the effects mask.

- **Input**: The orange input is used for the primary 2D image that gets noise removed.
- **Effect Mask**: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the noise removal change to be within the pixels of the mask. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup
The Remove Noise node can be used on any clip with noise. For example, it is used below to remove noise prior to keying the clip using the DeltaKeyer.

A Remove Noise node used to remove noise prior to keying
Inspector

Controls Tab
The Controls tab switches the noise removal between two methods: Color and Chroma. When the Method is set to Color, the Controls tab adjusts the amount of blur and sharpness individually for each RGB channel. When the Method is set to Chroma, the blur and sharpness is adjusted based on Luma and Chroma controls.

Method
This menu is used to choose whether the node processes color using the Color or Chroma method. This also gives you a different set of control sliders.

Lock
This checkbox links the Softness and Detail sliders of each channel together.

Softness Red, Green, and Blue
The Softness sliders determine the amount of blur applied to each channel of the image. In Chroma mode, you have sliders for the softness in the Luminance and Chrominance channels, respectively.

Detail Red, Green, and Blue
The Sharpness sliders determine how much detail is reintroduced into each channel after each channel is softened. In Chroma mode, you have sliders for Luminance and Chrominance channels, respectively.

Common Controls

Settings Tab
The Settings tab controls are common to all Film nodes, so their descriptions can be found in the following "The Common Controls" section.
The Common Controls

Film nodes share a number of identical controls in the Inspector. This section describes controls that are common among Film nodes.

Inspector

The Common Film settings inspector

Settings Tab

The Settings tab in the Inspector can be found on every tool in the Film category. The Settings controls are even found on third-party Film-type plug-in tools. The controls are consistent and work the same way for each tool, although some tools do include one or two individual options, which are also covered here.

Blend

The Blend control is used to blend between the tool’s original image input and the tool’s final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming image. Commonly, this causes the tool to skip processing entirely, copying the input straight to the output.

Process When Blend Is 0.0

The tool is processed even when the input value is zero. This can be useful if processing of this node is scripted to trigger another task, but the value of the node is set to 0.0.

Red/Green/Blue/Alpha Channel Selector

These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.

For example, if the red button on a Blur tool is deselected, the blur is first applied to the image, and then the red channel from the original input is copied back over the red channel of the result.
There are some exceptions, such as tools for which deselecting these channels causes the tool to skip processing that channel entirely. Tools that do this generally possess a set of identical RGBA buttons on the Controls tab in the tool. In this case, the buttons in the Settings and the Controls tabs are identical.

**Apply Mask Inverted**
Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

**Multiply by Mask**
Selecting this option causes the RGB values of the masked image to be multiplied by the mask channel’s values. This causes all pixels not included in the mask (i.e., set to 0) to become black/transparent.

**Use Object/Use Material (Checkboxes)**
Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports Object and Material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels are used, if present. The specific Material ID or Object ID affected is chosen using the next set of controls.

**Correct Edges**
This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information on Coverage and Background Color channels, see Chapter 18, “Understanding Image Channels” in the Fusion Studio Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.

**Object ID/Material ID (Sliders)**
Use these sliders to select which ID is used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker: to grab IDs from the image displayed in the view. The image or sequence must have been rendered from a 3D software package with those channels included.

**Clipping Mode**
This option determines how edges are handled when performing domain of definition rendering. This is mostly important for nodes like Blur, which may require samples from portions of the image outside the current domain.

- **Frame:** The default option is Frame, which automatically sets the node’s domain of definition to use the full frame of the image, effectively ignoring the current domain of definition. If the upstream DoD is smaller than the frame, the remaining area in the frame is treated as black/transparent.

- **Domain:** Setting this option to Domain respects the upstream domain of definition when applying the node’s effect. This can have adverse clipping effects in situations where the node employs a large filter.

- **None:** Setting this option to None does not perform any source image clipping at all. This means that any data required to process the node’s effect that would normally be outside the upstream DoD is treated as black/transparent.
Use GPU

The Use GPU menu has three settings. Setting the menu to Disable turns off hardware-accelerated rendering using the graphics card in your computer. Enabled uses the hardware. Auto uses a capable GPU if one is available and falls back to software rendering when a capable GPU is not available.

Comments

The Comments field is used to add notes to a tool. Click in the empty field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

Scripts

Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
Chapter 100

Filter Nodes

This chapter details the Filter nodes available in Fusion.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

Create Bump Map [CBu] 1951
Custom Filter Node [CFit] 1953
Erode Dilate Node [ErDi] 1957
Filter Node [Fltr] 1959
Rank Filter Node [RFit] 1961
The Common Controls 1963
Create Bump Map Node Introduction
The Create Bump Map node converts a grayscale (height map) image into a bump map. Unlike the Bump Map node that turns an image into a 3D material, the Create Bump Map node creates bump vector data and provides the output as an RGB image so other image-processing operations can be applied.

Input
The Create Bump Map node includes two inputs: one for the main image and the other for an effect mask to limit the area where the bump map is created.

- **Input**: The orange input takes the RGBA channels from an image to calculate the bump map.
- **Effect Mask**: The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the creation of the bump map to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup
The Create Bump Map node accepts a 2D grayscale image like a fast noise, which can then go through various 2D image-processing filters to create the bump map texture.
Inspector

Controls Tab
The Controls tab contains all parameters for creating the bump map.

Filter Size
This menu sets the filter size for creating the bump map. You can set the filter size at 3 x 3 pixels or 5 x 5 pixels, thus determining the radius of the pixels sampled. The larger the size, the more time it takes to render.

Height Source
The Height Source menu selects the channel for extracting the grayscale information.

Clamp Normal.Z
This slider clips the lower values of the blue channel in the resulting bump texture.

Wrap Mode
This menu determines how the image wraps at the borders, so the filter produces a correct result when using seamless tiling textures.

Height Scale
The height scale menu modifies the contrast of the resulting values in the bump map. Increasing this value yields in a more visible bump map.

Bump Map Texture Depth
This menu matches or converts the resulting bump texture into the desired bit depth.

NOTE: The below definitions are provided to clarify some of the terminology used in the Create Bump Map node and other similar types of nodes.

– **Height Map**: A grayscale image containing a height value per pixel.
– **Bump Map**: An image containing normals stored in the RGB channels used for modifying the existing normals (usually given in tangent space).
– **Normal Map**: An image containing normals stored in the RGB channels used for replacing the existing normals (usually given in tangent or object space).

Common Controls

Settings Tab
The Settings tab controls are common to all Filter nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.
Custom Filter Node [CFlt]

Custom Filter Node Introduction

The Custom Filter node is used to apply custom convolution filters to images. A custom convolution filter can give a wide variety of image effects. For example, emboss, relief, sharpen, blurring, and edge detection are all convolution filters. There are many supplied custom filters in the Filters directory that can be loaded by right-clicking on the control header and selecting Settings > Load from the contextual menu.

The Custom filter uses an array (or grid) of either 3 x 3, 5 x 5, or 7 x 7 values. (Note: The array in the Inspector always shows a 7 x 7 grid; however, setting the Matrix Size to 3 x 3 uses only the center 9 cells.) The center of the array represents the current pixel, and entries nearby represent adjacent pixels. A value of 1 applies the full value of the pixel to the filter. A value of 0 ignores the pixel’s value. A value greater than 1 multiplies the pixel’s effect on the result. Negative values can also be entered, where the value of the pixel is subtracted from the average. Only integer values can be entered; 0.x is not valid.

Input

The Custom Filter node includes two inputs: one for the main image and the other for an effect mask to limit the area where the custom filter is applied.

- **Input**: The orange input takes the RGBA channels from an image to calculate the custom filter.
- **Effect Mask**: The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the custom filter to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

The Custom Filter node can be inserted after an image, mask, or any node that needs a custom convolution filter applied.
Inspector

Controls Tab
The Controls tab is used to set the filter size and then use the filter matrix to enter convolution filter values.

Color Channels (RGBA)
The custom filter defaults to operating on R, G, B, and A channels. Selective channel editing is possible by enabling or disabling the checkboxes beside each channel.

This is not the same as the RGBA checkboxes found under the Common Controls. The node takes these controls into account before it processes. Deselecting a channel causes the node to skip that channel when processing, speeding up the rendering of the effect. In contrast, these controls under the Common Controls tab are applied after the node has processed.

Matrix Size
This menu is used to set the size of the filter at 3 x 3 pixels, 5 x 5 pixels, or 7 x 7 pixels, thus setting the radius of the pixels sampled. The larger the size, the more time it takes to render.

Update Lock
When this control is selected, Fusion does not render the filter. This is useful for setting up each value of the filter, and then turning off Update Lock and rendering the filter.

Filter Matrix
The Filter Matrix control is a 7 x 7 grid of text boxes where a number is entered to represent how much influence each pixel has on the overall convolution filter. The text box in the center represents the pixel that is processed by the filter. The text box to the left of the center represents the pixel to the immediate left, and so forth.

The default Matrix size is 3 x 3. Only the pixels immediately adjacent to the current pixel are analyzed. If a larger Matrix size is set, more of the text boxes in the grid are enabled for input.

Normalize
This controls the amount of filter normalization that is applied to the result. Zero gives a normalized image. Positive values brighten or raise the level of the filter result. Negative values darken or lower the level.

Floor Level
This adds or subtracts a minimum, or Floor Level, to the result of the filtered image. Zero does not add anything to the image. Positive values add to the filtered image, and negative values subtract from the image.
Examples

**Original Image Example**

For example, a filter with the values...

\[
\begin{bmatrix}
0 & 0 & 0 \\
0 & 1 & 0 \\
0 & 0 & 0
\end{bmatrix}
\]

...has zero effect from its neighboring pixels, and the resulting image would be unchanged.

**Softening Example**

A slight softening effect would be...

\[
\begin{bmatrix}
1 & 1 & 1 \\
1 & 1 & 1 \\
1 & 1 & 1
\end{bmatrix}
\]

...where the neighboring pixels are averaged with the center.

**Emboss Example**

The example below subtracts five times the value from the top left and adds five times the value from the lower right.

\[
\begin{bmatrix}
-5 & 0 & 0 \\
0 & 1 & 0 \\
0 & 0 & 5
\end{bmatrix}
\]

If parts of the processed image are very smooth in color, the neighboring values are very similar.
In parts of the image where the pixels are different (e.g., an edge), the results are different and tend to highlight or emboss edges in the image.

**Exposure Example**

Using the values...

```
1 1 1
1 1 1
1 1 1
```

...and adjusting Normalize to a positive value makes the image brighter or glow, simulating film overexposure.

**Relief Example**

Using the values...

```
-1 0 0
0 0 0
0 0 1
```

... and adjusting Floor Level to a positive value creates a Relief filter.
Common Controls

Settings Tab
The Settings tab controls are common to all Filter nodes, so their descriptions can be found in “The
Common Controls” section at the end of this chapter.

Erode Dilate Node [ErDI]

Erode Dilate Node Introduction
The Erode Dilate node contracts or expands the image, depending on whether the Amount slider is
set to a negative or positive value.

Inputs
The Erode Dilate node includes two inputs: one for the main image and the other for an effect mask to
limit the area where the erode or dilate is applied.

– **Input:** The orange input takes the RGBA channels from an image to calculate the custom filter.
– **Effect Mask:** The optional blue effect mask input accepts a mask shape created by polylines,
basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this
input limits the erode or dilate to only those pixels within the mask. An effects mask is applied
to the tool after the tool is processed.

Basic Node Setup
The Erode Dilate node is commonly used to contract or expand mattes. Below, a Luma Keyer is
connected to the Erode Dilate and passes the modified key to a Matte Control where it is embedded
into the image.
Inspector

Controls Tab
The Controls tab includes the main Amount slider that determines whether you are performing an erode by entering a negative value or a dilate by entering a positive value.

Color Channels (RGBA)
The Erode Dilate node defaults to operating on R, G, B, and A channels. Selective channel editing is possible by enabling or disabling the checkboxes beside each channel.

This is not the same as the RGBA checkboxes found under the Common Controls. The node takes these controls into account before it processes. Deselecting a channel causes the node to skip that channel when processing, speeding up the rendering of the effect. In contrast, the channel controls under the Common Controls tab are applied after the node has processed.

Lock X/Y
The Lock X/Y checkbox is used to separate the Amount slider into amount X and amount Y, allowing a different value for the effect on each axis.

Amount
A negative value for Amount causes the image to erode. Eroding simulates the effect of an underexposed frame, shrinking the image by growing darker areas of the image so that they eat away at brighter regions.

A positive value for Amount causes the image to dilate, similar to the effect of overexposing a camera. Regions of high luminance and brightness grow, eating away at the darker regions of the image. Both techniques eradicate fine detail in the image and tend to posterize fine gradients.

The Amount slider scale is based on the input image width. An amount value of 1 = image width. So, if you want to erode or dilate by exactly 1 pixel on an HD image, you would enter 1/1920, or 0.00052083.

Common Controls

Settings Tab
The Settings tab controls are common to all Filter nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.
Filter Node Introduction

The Filter node contains several standard convolution filters, easily selectable from a list. This node enables a variety of effects, from radically changing the look of an image to adding subtle randomly-generated film grain. The Sobel and Laplacian settings are often used for edge detection.

Inputs

The Filter node includes two inputs: one for the main image and the other for an effect mask to limit the area where the filter is applied.

- **Input**: The orange input is used for the primary 2D image that gets the filter applied.
- **Effect Mask**: The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the filter to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

The Filter node can be inserted after an image, mask, or any node that needs a filter applied. Below, it is used to create an edge matte, which is then used to mask the soft glow around the keyed foreground.

A Filter node using the Sobel setting to extract an edge matte
Inspector

Controls Tab
The Controls tab is used to set the filter type, the channels the filter is applied to, and the amount it blends with the original image.

Filter Type
The Filter Type menu provides a selection of filter types described below.

- Relief: This appears to press the image into metal, such as an image on a coin. The image appears to be bumped and overlaid on gray.
- Emboss Over: Embosses the image over the top of itself, with adjustable highlight and shadow height and direction.
- Noise: Uniformly adds noise to images. This is often useful for 3D computer-generated images that need to be composited with live action, as it reduces the squeaky-clean look that is inherent in rendered images. The frame number acts as the random generator seed. Therefore, the effect is different on each frame and is repeatable.
- Defocus: This filter type blurs the image.
- Sobel: Sobel is an advanced edge detection filter. Used in conjunction with a Glow filter, it creates impressive neon light effects from live-action or 3D-rendered images.
- Laplacian: Laplacian is a very sensitive edge detection filter that produces a finer edge than the Sobel filter.
- Grain: Adds noise to images similar to the grain of film (mostly in the midrange). This is useful for 3D computer-generated images that need to be composited with live action as it reduces the squeaky-clean look that is inherent in rendered images. The frame number acts as the random generator seed. Therefore, the effect is different on each frame and is repeatable.

Color Channels (RGBA)
The Filter node defaults to operating on R, G, B, and A channels. Selective channel editing is possible by enabling or disabling the checkboxes beside each channel.

Power
Values range from 1 to 10. Power proportionately increases the amount by which the selected filter affects the image. This does not apply to the Sobel or Laplacian filter type.
Angle
This control has a range from 0 to 315 degrees and changes the effect in increments of 45 degrees. This applies only to the Relief and Emboss filters.

Median
Depending on which Filter Type is selected, the Median control may appear. It varies the Median filter’s effect. A value of 0.5 produces the true median result, as it finds the middle values. A value of 0.0 finds the minimums, and 1.0 finds the maximums. This applies to the Median setting only.

Seed
This control is visible only when applying the Grain or Noise filter types. The Seed slider can be used to ensure that the random elements of the effect are seeded with a consistent value. The randomizer always produces the same result, given the same seed value.

Animated
This control is visible only when applying the Grain or Noise filter types. Select the checkbox to cause the noise or grain to change from frame to frame. To produce static noise, deselect this checkbox.

Common Controls

Settings Tab
The Settings tab controls are common to all Filter nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.

Rank Filter Node [RFIt]

Rank Filter Node Introduction
The Rank Filter examines nearby pixels, sorts the pixels by value, and then replaces the color of the examined pixels with the color of the pixel with the selected rank.

Inputs
The Rank Filter node includes two inputs: one for the main image and the other for an effect mask to limit the area where the filter is applied.

- **Input**: The orange input is used for the primary 2D image that gets the Rank filter applied.
- **Effect Mask**: The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the rank filter to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.
Basic Node Setup

The Rank Filter node can be placed anywhere in a node tree to apply an effect to an image.

![A Rank Filter node placed after a MediaIn node in DaVinci Resolve](image)

Inspector

![Rank Filter controls](image)

Controls Tab

The Controls tab is used to set the size and rank value of the filter.

**Size**

This control determines the size in pixels of the area sampled by the filter. A value of 1 samples 1 pixel in each direction, adjacent to the center pixel. This produces a total of 9 pixels, including the center sampled pixel. Larger values sample from a larger area.

Low Size settings are excellent for removing salt and pepper style noise, while larger Size settings produce an effect similar to watercolor paintings.

**Rank**

The Rank slider determines which value from the sampled pixels is chosen. A value of 0 is the lowest value (darkest pixel), and 1 is the highest value (brightest pixel).

Example

Below is a before and after example of a Rank filter with Size set to 7 and a Rank of 0.7 to create a watercolor effect.

![Before and after of a Rank Filter producing a watercolor-style effect](image)
The Common Controls

Filter nodes share a number of identical controls in the Inspector. This section describes controls that are common among Filter nodes.

Inspector

The Settings tab in the Inspector can be found on every tool in the Filter category. The Settings controls are even found on third-party filter-type plug-in tools. The controls are consistent and work the same way for each tool, although some tools do include one or two individual options, which are also covered here.

**Blend**

The Blend control is used to blend between the tool's original image input and the tool's final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming image. Normally, this causes the tool to skip processing entirely, copying the input straight to the output.

**Process When Blend Is 0.0**

The tool is processed even when the input value is zero. This can be useful if processing of this node is scripted to trigger another task, but the value of the node is set to 0.0.
**Red/Green/Blue/Alpha Channel Selector**

These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.

For example, if the red button on a Blur tool is deselected, the blur is first applied to the image, and then the red channel from the original input is copied back over the red channel of the result.

There are some exceptions, such as tools for which deselecting these channels causes the tool to skip processing that channel entirely. Tools that do this generally possess a set of identical RGBA buttons on the Controls tab in the tool. In this case, the buttons in the Settings and the Controls tabs are identical.

**Apply Mask Inverted**

Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

**Multiply by Mask**

Selecting this option causes the RGB values of the masked image to be multiplied by the mask channel's values. This causes all pixels of the image not included in the mask (i.e., set to 0) to become black/transparent.

**Use Object/Use Material (Checkboxes)**

Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports Object ID and Material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels are used, if present. The specific Material ID or Object ID affected is chosen using the next set of controls.

**Correct Edges**

This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information on Coverage and Background Color channels, see Chapter 18, “Understanding Image Channels” in the Fusion Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.

**Object ID/Material ID (Sliders)**

Use these sliders to select which ID is used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker: to grab IDs from the image displayed in the view. The image or sequence must have been rendered from a 3D software package with those channels included.

**Use GPU**

The Use GPU menu has three settings. Setting the menu to Disable turns off hardware-accelerated rendering using the graphics card in your computer. Enabled uses the hardware. Auto uses a capable GPU if one is available and falls back to software rendering when a capable GPU is not available.
Motion Blur

- **Motion Blur:** This toggles the rendering of Motion Blur on the tool. When this control is toggled on, the tool’s predicted motion is used to produce the motion blur caused by the virtual camera’s shutter. When the control is toggled off, no motion blur is created.

- **Quality:** Quality determines the number of samples used to create the blur. A quality setting of 2 causes Fusion to create two samples to either side of an object’s actual motion. Larger values produce smoother results but increase the render time.

- **Shutter Angle:** Shutter Angle controls the angle of the virtual shutter used to produce the motion blur effect. Larger angles create more blur but increase the render times. A value of 360 is the equivalent of having the shutter open for one whole frame exposure. Higher values are possible and can be used to create interesting effects.

- **Center Bias:** Center Bias modifies the position of the center of the motion blur. This allows for the creation of motion trail effects.

- **Sample Spread:** Adjusting this control modifies the weighting given to each sample. This affects the brightness of the samples.

Comments
The Comments field is used to add notes to a tool. Click in the empty field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

Scripts
Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
Chapter 101

Flow Nodes

This chapter details the Sticky Note and Underlay features available in Fusion.

The abbreviations next to each feature name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

Sticky Note [NTE] 1967
Sticky Note Introduction 1967
Usage 1967
Underlay [UND] 1968
Underlay Introduction 1968
Usage 1968

Chapter 101  Flow Nodes  1966
Sticky Note Introduction

A Sticky Note is not a node at all. It is a useful way of attaching notes, comments, and history to a specific area of a comp. By changing their size and color, they can provide unobtrusive comments or important notices, as required. Sticky Notes make an excellent complement to the Comments tab in the Inspector.

Usage

To create a Sticky Note, click in an empty area of the Node Editor where you want a Sticky Note to appear. Then, from the Effects Library, click the Sticky Note effect located in the Tools > Flow category or press Shift-Spacebar and search for the Sticky Note in the Select Tool window.

Like Groups, Sticky Notes are created in a smaller, collapsed form. They can be expanded by double-clicking on them. Once expanded, they can be resized using any side or corner of the note or moved by dragging on the name header. To collapse the Sticky Note again, click the icon in the top-left corner.

To rename, delete, copy, or change the color of the note, right-click over the note and choose from the contextual menu. Using this menu, you can also lock the note to prevent editing.

To edit the text in a Sticky Note, first expand it by double-clicking anywhere on the note, and then click below its title bar. If the note is not locked, you can edit the text.
**Underlay [UND]**

The Underlay

**Underlay Introduction**

Underlays are a convenient method of visually organizing areas of a composition. As with Groups, Underlays can improve the readability of a comp by separating it into labeled functional blocks. While Groups are designed to streamline the look of a comp by collapsing complex layers down to single nodes, Underlays highlight, rather than hide, and do not restrict outside connections.

**Usage**

As with Sticky Notes, an Underlay can be added to a comp by selecting it from the Flow category in the Effects Library or searching for it in the Select Tool window. The Underlay to the Node Editor with its title bar is centered on the last-clicked position.

Underlays can be resized using any side or corner. This will not affect any nodes.

Underlays can also be used as simple selection groups. Activating an Underlay, by clicking its title, will select all the tools contained wholly within it as well, allowing the entire set to be moved, duplicated, passed through, and so on.

To rename an Underlay, first ensure that nodes contained within the Underlay are not selected. Then, Option-click on the Underlay title to select the Underlay without selecting the nodes it contains. Once selected, right-click over the title and choose Rename. Underlays can be assigned a color using the same right-click contextual menu.
Flow Organizational Nodes

This chapter details the Groups, Macro, and Pipe Router nodes, which are designed to help organize your compositions, making the node tree easier to see and understand.

For purposes of this document, node trees showing Medialn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

Groups
Groups Introduction 1970
Usage 1970

Macro
Macro Introduction 1971
Usage 1971
Macro Editor 1971
The Final Macro 1972

Pipe Router
Router Introduction 1972
Usage 1973
Router 1973
Groups

Groups Introduction

Groups are used to keep complex node trees organized. You can select any number of nodes in the node tree and then group them to create a single node icon in the Node Editor. Groups are non-destructive and can be opened at any time.

Usage

- To group nodes, select them in the Node Editor, and then right-click over any of the selected nodes and choose Group from the contextual menu.

- To edit the individual nodes in a group, right-click and choose Expand Group from the contextual menu. All individual nodes contained in the group are displayed in a floating node tree window. When opened, groups hover over existing elements, allowing editing of the enclosed nodes.

- To remove or decompose a group and retain the individual nodes, right-click the group and choose Ungroup.
Macros are not technically a node. Instead, they are a group of nodes that act as a single node.

**Macro Introduction**

Macros can be used to combine multiple nodes and expose a user-definable set of controls. They are meant as a fast and convenient way of building custom nodes.

**Usage**

To create a Macro, select the nodes intended for the macro. The order in which the nodes are selected becomes the order in which they are displayed in the Macro Editor. Right-click on any of the selected nodes and choose Macro > Create Macro from the contextual menu.

The Macro Editor allows you to specify and rename the controls that are exposed in the final macro tool.

In the example below, the tool is named Light_Wrap at the top. The Blur slider for Matte Control 1 is enabled and renamed to Softness, as it will appear in the Inspector.
After setting up the macro to your liking, click the Close button in the lower-right corner of the dialog. Then, in the Save dialog, click Yes to save the macro, click No to leave Macro Editor without saving the changes, or click Cancel to return to the Macro Editor.

The Macro Editor save dialog

To add the macro to your node tree, right-click anywhere on the node tree and select Macro > [NameOfYourMacro] from the contextual menu.

Saving a Macro as a Title Template in the Edit Page (DaVinci Resolve)

When using DaVinci Resolve, macros are available only in the Fusion page. However, if the macro is a title animation, you can save it to the Titles Templates folder and have it appear in the Edit page Effects Library.

To save a title macro so it appears in the Edit page Effects Library, save the macro to:

macOS:
Users > UserName > Library > Application Support > Blackmagic Design > DaVinci Resolve > Fusion > Templates > Edit > Titles

Windows:
C Drive > Users > UserName > AppData > Roaming > Blackmagic Design > DaVinci Resolve > Support > Fusion > Templates > Edit > Titles

The Final Macro

The final macro looks and behaves just like any other node in Fusion.

As another example, you could take a single Channel Boolean, set it to Add mode, and make it into a macro exposing no controls at all, thus creating the equivalent of an Add Mix node like the one that can be found in programs like Nuke.

Pipe Router

Pipe Routers are another type of organizational tool you use to improve the layout and appearance of the node tree.

Router Introduction

Routers can be used to neatly organize your comps by creating "elbows" in your node tree, so the connection lines do not overlap nodes, making them easier to understand. Routers do not have any influence on render times.
Usage

A Pipe Router usage example

Router

To insert a router along a connection line, Option- or Alt-click on the line. The router can then be repositioned to arrange the connections as needed.

Although routers have no actual controls, they still can be used to add comments to a comp.

An example comment in a Router node
Chapter 103

Fuses

This chapter introduces Fuses, which are scriptable plug-ins that can be used within Fusion.

Contents

Fuses [FUS] 1975
Fuses Introduction 1975
Installing Fuses 1975
Working with Fuses in a Composition 1975
Fuses Introduction

Fuses are plug-ins. The difference between a Fuse and an Open FX plug-in is that a Fuse is created using a Lua script. Fuses can be edited within Fusion or DaVinci Resolve, and the changes you make compile on-the-fly.

Using a Lua script makes it easy for even non-programmers to prototype and develop custom nodes. A new Fuse can be added to a composition, edited and reloaded, all without having to close the current composition. They can also be used as modifiers to manipulate parameters, curves, and text very quickly. ViewShader Fuses can make use of the GPU for faster performance. This makes Fuses much more convenient than an Open FX plug-in that uses Fusion’s OFX SDK. However, this flexibility comes at a cost. Since a Fuse is compiled on-the-fly, it can be significantly slower than the identical node created using the Open FX SDK.

As an example, Fuses could generate a mask from the over-exposed areas of an image, or create initial particle positions based on the XYZ position stored within a text file.

Please contact Blackmagic Design for access to the SDK (Software Developer Kit) documentation.

Installing Fuses

Fuses are installed in the Fusion:\Fuses path map. By default this folder is located at Users/User_Name/Library Application Support/Blackmagic Design/Fusion (or DaVinci Resolve)/Fuses on macOS or C:\Users\User_Name\AppData\Roaming\Blackmagic Design\Fusion (or DaVinci Resolve)\Fuses, on Windows. Files must use the extension .fuse, or they will be ignored by Fusion.

Working with Fuses in a Composition

Fuses can be designed to appear in any category in the Effects Library. Once installed, they are added to a composition exactly as any native or third-party plug-in node. However, since a Fuse is just a text document, it can be edited by clicking the Edit button that appears at the top of the Inspector when the Fuse node is selected. This will open the Fuse in the default script editor specified in the Global Preferences/Scripting panel.

**NOTE:** Any changes made to a Fuse’s script do not immediately affect other copies of the same Fuse node already added to a composition. To use the updated Fuse script on all similar Fuses in the composition, either close and reopen the composition, or click on the Reload button in each Fuse’s Inspector.

When a composition containing a Fuse node is opened, the currently saved version of the Fuse script is used. The easiest way to ensure that a composition is running the current version of a Fuse is to close and reopen the composition.
Chapter 104

Generator Nodes

This chapter details the Generator nodes available in Fusion. The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

Background [BG] 1977
Day Sky [DS] 1981
Fast Noise [FN] 1983
Mandelbrot [MAN] 1986
Plasma [PLAS] 1989
Text+ [TXT+] 1991
Text+ Modifiers 2003
Character Level Styling 2003
Comp Name 2004
Follower 2004
Text Scramble 2006
Text Timer 2007
Time Code 2007
The Common Controls 2008
Background [BG]

Background Node Introduction
The Background node can be used to produce anything from a solid color background to complex looped gradients.

Inputs
There is one input on the Background node for an effect mask input.

- **Effect Mask**: The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the background color to only those pixels within the mask.

Basic Node Setup
The Background node generates a color and passes the color off to another node like the Paint node below.

Inspector
The Background node controls
Color Tab
The Color tab is used to control the style and color(s) of the generated background.

Type
This control is used to select the style of background generated by the node. Four selections are available:

- **Solid Color**: This default creates a single-color image.
- **Horizontal**: This creates a two-color horizontal gradation.
- **Vertical**: This creates a two-color vertical gradation.
- **Four Corner**: This creates a four-color corner gradation.

Horizontal/Vertical/Four Point
When the Type menu is set to Horizontal, Vertical, or Four Corner, two- or four-color swatches are displayed where the left/right, top/bottom, or four corners of the gradient colors can be set.
Gradient controls

Gradient
When the Type menu is set to Gradient, additional controls are displayed where the gradient colors’ direction can be customized.

Gradient Type
This menu selects the form used to draw the gradient. There are six choices:

- **Linear**: Draws the gradient along a straight line from the starting color stop to the ending color stop.
- **Reflect**: Draws the gradient by mirroring the linear gradient on either side of the starting point.
- **Square**: Draws the gradient by using a square pattern when the starting point is at the center of the image.
- **Cross**: Draws the gradient using a cross pattern when the starting point is at the center of the image.
- **Radial**: Draws the gradient in a circular pattern when the starting point is at the center of the image.
- **Angle**: Draws the gradient in a counterclockwise sweep when the starting point is at the center of the image.

Viewer Start and End Position
The Start and End positions in the viewer are represented by two red control points connected by a green line. They determine where the gradient begins and ends.

Gradient Colors
This gradient color bar is used to select the colors for the gradient. The default two color stops set the start and end colors. You can change the colors used in the gradient by selecting the color stop, and then using the Eyedropper or color swatch to set a new color.

You can add, move, copy, and delete color from the gradient using the gradient bar.
To modify one of the colors, select the triangle below the color on the bar.

**To add a color stop to the gradient bar:**
1. Click anywhere along the bottom of the gradient bar.
2. Use the Eyedropper or color swatch to select the color for the color stop.

**To move a color stop on the gradient bar:**
- Drag a color stop left or right along the bar.

**To copy a color stop:**
- Hold Command (macOS) or Ctrl (Windows) while you drag a color stop.

**To delete a color stop:**
- Drag the color stop up past the gradient bar.

**Interpolation Space**
This menu determines what color space is used to calculate the colors between color stops.

**Offset**
The Offset control is used to offset the position of the gradient relative to the start and end markers. This control is most useful when used in conjunction with the repeat and ping-pong modes described below.

**Repeat**
This menu includes three options used to set the behavior of the gradient when the Offset control scrolls the gradient past its start and end positions. Selecting Once keeps the color continuous for offset. Selecting Repeat loops around to the start color when the offset goes beyond the end color. Selecting Ping-pong repeats the color pattern in reverse.

**Sub-Pixel**
The Sub-Pixel menu controls the sub-pixel precision used when the edges of the gradient become visible in repeat mode, or when the gradient is animated. Higher settings will take significantly longer to render but are more precise.

**Gradient Contextual Menu**
Gradients have their own contextual menu that you can bring up by right-clicking on the gradient bar. The Gradient contextual menu includes options for animating, publishing, and connecting one gradient to another. There is also a gradient-specific modifier that builds a custom gradient by sampling colors from the output of a node.

**Common Controls**

**Image and Settings Tabs**
The Image and Settings tabs in the Inspector are duplicated in many Generator nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
Day Sky [DS]

The Day Sky node

Day Sky Node Introduction

The Day Sky node aims to produce a simulation of the daylight produced at a specific time and location on the earth, and generates a high dynamic range image that represents a map of that light. It is not a sky generator, although it could be combined with a cloud generator or Noise node to produce one.

NOTE: This generator is a practical implementation of the research paper, A Practical Analytical Model for Daylight, by Preetham, Shirley, and Smits. A copy of the original paper can be found at the website for the Visual Simulation Group at the University of Utah [https://www.cs.utah.edu/~shirley/papers/sunsky/sunsky.pdf].

Inputs

There is a single input on the Day Sky node for an effect mask to limit the area where the day sky simulation occurs is applied.

– Effect Mask: The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the Day Sky to only those pixels within the mask.

Basic Node Setup

The Day Sky node is a generator, so it typically starts the branch of a node tree and connects to some other node, like a Merge node.

A Day Sky connected as the background to a Merge node
Inspector

Day Sky node controls

Controls Tab
The Controls tab is used to set the location and time of the daylight simulation. This will determine the overall look that is generated.

Location
The Latitude and Longitude sliders are used to specify the location used to create the Day Sky simulation.

Date and Time
The Day, Month, and Time controls are used to select the specific time for the Day Sky simulation.

Turbidity
Turbidity causes light to be scattered and absorbed instead of transmitted in straight lines through the simulation. Increasing the turbidity will give the sky simulation a murky feeling, as if smoke or atmospheric haze were present.

Do Tone Mapping
Since the simulation is calculated in 32-bit floating-point color space, it generates color values well above 1.0 and well below 0.0. Tone mapping is a process that takes the full dynamic range of the resulting simulation and compresses the data into the desired exposure range while attempting to preserve as much detail from the highlights and shadows as possible. Deselect this checkbox to disable any tone mapping applied to the simulation.
Generally, this option should be deselected only if the resulting image will later be color corrected as part of a floating-point color pipeline.

Exposure
Use this control to select the exposure used for tone mapping.
Advanced Tab
The Advanced tab provides more specific controls over the brightness and width of the different ranges in the generated sky.

Horizon Brightness
Use this control to adjust the brightness of the horizon relative to the sky.

Luminance Gradient
Use this control to adjust the width of the gradient separating the horizon from the sky.

Circumsolar Region Intensity
Use this control to adjust the intensity or brightness of the sky nearest to the sun.

Circumsolar Region Width
Use this control to adjust the width or size of the area in the sky affected by the sun.

Backscattered Light
Use this control to increase or decrease the backscatter light in the simulation.

Common Controls

Image and Settings Tabs
The Image and Settings tabs in the Inspector are duplicated in many Generator nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Fast Noise [FN]

Fast Noise Node Introduction
The Fast Noise node is a very fast and flexible Perlin Noise generator. It can be useful for a wide range of effects, from clouds, to swirling fog, waves, water caustics, stylized fire, and smoke, and other
organic textures. It is also invaluable as a noise source for other effects, such as heat shimmers, particle systems, and dirtiness maps.

**Inputs**

The two map inputs on the Fast Noise node allow you to use masks to control the value of the noise detail and brightness controls for each pixel. These two optional inputs can allow some interesting and creative effects. There is also a standard effect mask input for limiting the Fast Noise size.

- **Noise Detail Map:** A soft-edged mask connected to the gray Noise Detail Map input will give a flat noise map (zero detail) where the mask is black, and full detail where it is white, with intermediate values smoothly reducing in detail. It is applied before any gradient color mapping. This can be very helpful for applying maximum noise detail in a specific area, while smoothly falling off elsewhere.

- **Noise Brightness Map:** A mask connected to this white input can be used to control the noise map completely, such as boosting it in certain areas, combining it with other textures, or if Detail is set to 0, replacing the Perlin Noise map altogether.

- **Effect Mask:** The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the Fast Noise to only those pixels within the mask.

**Basic Node Setup**

The Fast Noise node is used to generate images for other nodes to take advantage of. For example, below the Fast Noise node is used as a bitmap source in the Particle Emitter.

![A Fast Noise node used as a bitmap source for a Particle Emitter](image)

**Inspector**

![Fast Noise controls](image)
Noise Tab
The Noise tab controls the shape and pattern of the noise for the Fast Noise node.

Discontinuous
Normally, the noise function interpolates between values to create a smooth continuous gradient of results. Enable this checkbox to create hard discontinuity lines along some of the noise contours. The result will be a dramatically different effect.

Inverted
Select this checkbox to invert the noise, creating a negative image of the original pattern. This is most effective when Discontinuous is also enabled.

Center
Use the Center coordinate control to pan and move the noise pattern.

Detail
Increase the value of this slider to produce a greater level of detail in the noise result. Larger values add more layers of increasingly detailed noise without affecting the overall pattern. High values take longer to render but can produce a more natural result.

Brightness
This control adjusts the overall brightness of the noise map, before any gradient color mapping is applied. In Gradient mode, this has a similar effect to the Offset control.

Contrast
This control increases or decreases the overall contrast of the noise map, prior to any gradient color mapping. It can exaggerate the effect of the noise and widen the range of colors applied in Gradient mode.

Lock and Scale X/Y
The size of the noise map can be adjusted using the Scale slider, changing it from gentle variations over the whole image to a tighter overall texture effect. The Scale slider can be separated into independent X- and Y-axis scale sliders by clicking on the Lock X/Y checkbox immediately above, which can be useful for a brushed-metal effect.

Angle
Use the Angle control to rotate the noise pattern.

Seethe
Adjust this thumbwheel control to interpolate the noise map against a different noise map. This will cause a crawling shift in the noise, as if it was drifting or flowing. This control must be animated to affect the gradient over time, or you can use the Seethe Rate control below.

Seethe Rate
As with the Seethe control above, the Seethe Rate also causes the noise map to evolve and change. The Seethe Rate defines the rate at which the noise changes each frame, causing an animated drift in the noise automatically, without the need for spline animation.
Color Tab
The Color tab allows you to adjust the gradient colors used in the generated noise pattern.

Two Color
A simple two-color gradient is used to color the noise map. The noise function will smoothly transition from the first color into the second.

Gradient
The Advanced Gradient control in Fusion is used to provide more control over the color gradient used with the noise map.

Common Controls
Image and Settings Tabs
The Image and Settings tabs in the Inspector are duplicated in many Generator nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

Mandelbrot [MAN]
Mandelbrot Node Introduction

This node creates an image pattern based on the Mandelbrot fractal theory set.

Inputs

The one input on the Mandelbrot node is for an effect mask to limit the area where the fractal noise is applied.

- **Effect Mask**: The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the fractals to only those pixels within the mask.

Basic Node Setup

The Mandelbrot node generates images that can be used for motion graphics and sci-fi effects. Below, it is used to generate motion graphics for the background of a title.

A Mandelbrot node applied as a background to the Merge node

Inspector

Mandelbrot node controls

Noise Tab

The Noise tab controls the shape and pattern of the noise for the Mandelbrot node.

**Position X and Y**

This chooses the image's horizontal and vertical position or seed point.

**Zoom**

Zoom magnifies the pattern in or out. Every magnification is recalculated so that there is no practical limit to the zoom.

**Escape Limit**

Defines a point where the calculation of the iteration is aborted. Low values lead to blurry halos.
Iterations
This determines the repetitiveness of the set. When animated, it simulates a growing of the set.

Rotation
This rotates the pattern. Every new angle requires recalculation of the image.

The Mandelbrot node Color tab

Color Tab
The Color tab allows you to adjust the gradient and repetition of the gradient colors for the generated pattern.

Grad Method
Use this control to determine the type of gradation applied at the borders of the pattern.

Continuous Potential
This causes the edges of the pattern to blend to the background color.

Iterations
This causes the edges of the pattern to be solid.

Gradient Curve
This affects the width of the gradation from the pattern to the background color.

R/G/B/A Phase and Repetitions
These controls set the color values of the pattern generators.

Common Controls

Image and Settings Tabs
The Image and Settings tabs in the Inspector are duplicated in other generator nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.
Plasma [PLAS]

The Plasma node

Plasma Node Introduction

The Plasma node is a background generation node that uses four circular patterns to generate images similar to plasma. It is useful as a deforming pattern for the Shadow and Deform nodes and to create a variety of other useful shapes and patterns. It is similar to the Fast Noise node.

Inputs

The one input on the Plasma node is for an effect mask to limit the area where the plasma pattern is applied.

- **Effect Mask**: The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the plasma to only those pixels within the mask.

Basic Node Setup

Like the Mandelbrot node, the Plasma node generates images that can be used for motion graphics and sci-fi effects. Below, it is used to generate motion graphics for the background of a title.

A Plasma node applied as a background to a Merge node

Inspector

Plasma node Circles tab
Circles Tab
The Circles tab controls the shape and pattern generated by the Plasma node.

Scale
The Scale control is used to adjust the size of the pattern created.

Operation
The options in this menu determine the mathematical relationship among the four circles whenever they intersect.

Circle Type
Select the type of circle to be used.

Circle Center
Report and change the position of the circle center.

Circle Scale
Determines the size of the circle to be used for the pattern.

Color Tab
The Color tab allows you to adjust the colors and location within the pattern of the colors for the generated plasma.

Phase
Phase changes the color phase of the entire image. When animated, this creates psychedelic color cycles.

R/G/B/A Phases
Changes the phase of the individual color channels and the Alpha. When animated, this creates color cycling effects.

Common Controls

Image and Settings Tabs
The Image and Settings tabs in the Inspector are duplicated in many Generator nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.
The Text+ node

Text+ Node Introduction

Fusion’s Text+ node is an advanced character generator capable of multiple styles, 3D transformations, and several layers of shading. Text can be laid out to a user-defined frame, circle, or along a path.

Any TrueType or PostScript 1 font installed on the computer can be used to create text. Support for multibyte and Unicode characters allows text generation in any language, including right to left and vertically oriented text.

This node generates a 2D image. To produce extruded 3D text with optional beveling, see the Text 3D node.

Inputs

The one input on the Text+ node is for an effect mask to crop the text.

- **Effect Mask:** The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the text to only those pixels within the mask.

Basic Node Setup

The Text+ node can be combined with many other nodes to create motion graphics. Below it is connected as the foreground of a Merge node.

Inspector
Text Tab

The Text tab in the Inspector is divided into three sections: Text, Advanced Controls, and Tab Spacing. The Text section includes parameters that will be familiar to anyone who has used a word processor. It includes commonly used text formatting options. The Advanced controls are used for kerning options, and the Tab Spacing is used to define the location and alignment of tabs in the layout.

Styled Text

The edit box in this tab is where the text to be created is entered. Any common character can be typed into this box. The common OS clipboard shortcuts (Command-C or Ctrl-C to copy, Command-X or Ctrl-X to cut, Command-V or Ctrl-V to paste) will also work; however, right-clicking in the edit box displays a custom contextual menu. More information on these modifiers can be found at the end of this section.

The Styled Text contextual menu includes the following options:

- **Animate:** Used to animate the text over time.
- **Character Level Styling:** Used to change the font, color, size and transformations of individual characters or words through the Modifiers tab.
- **Comp Name:** Places the name of the composition in the Styled text box for creating slates.
- **Follow:** A text modifier used to ripple animation across each character of the text.
- **Publish:** Publishes the text for connection to other text nodes.
- **Text Scramble:** A text modifier used to randomize the characters in the text.
- **Text Timer:** A text modifier used to display a countdown or the current date and time.
- **Time Code:** A text modifier used to display Time Code for the current frame.
- **Connect To:** Used to connect the text to the published output of another node.

Font

Two Font menus are used to select the font family and typeface, such as Regular, Bold, and Italic.
**Color**
Sets the basic fill color of the text. This is the same control displayed in the Shading tab color swatch.

**Size**
This control is used to increase or decrease the size of the text. This is not like selecting a point size in a word processor. The size is relative to the width of the image.

**Tracking**
The Tracking parameter adjusts the uniform spacing between each character of text.

**Line Spacing**
Line Spacing adjusts the distance between each line of text. This is sometimes called leading in word-processing applications.

**V Anchor**
The vertical anchor controls consist of three buttons and a slider. The three buttons are used to align the text vertically to the top of the text, middle of the text, or bottom baseline. The slider can be used to customize the alignment. Setting the vertical anchor will affect how the text is rotated as well as the location for line spacing adjustments. This control is most often used when the Layout type is set to Frame in the Layout tab.

**V Justify**
The vertical justify slider allows you to customize the vertical alignment of the text from the V Anchor setting to full justification so it is aligned evenly along the top and bottom edges. This control is most often used when the Layout type is set to Frame in the Layout tab.

**H Anchor**
The horizontal anchor controls consist of three buttons and a slider. The three buttons justify the text alignment to the left edge, middle, or right edge of the text. The slider can be used to customize the justification. Setting the horizontal anchor will affect how the text is rotated as well as the location for tracking (leading) spacing adjustments. This control is most often used when the Layout type is set to Frame in the Layout tab.

**H Justify**
The horizontal justify slider allows you to customize the justification of the text from the H Anchor setting to full justification so it is aligned evenly along the left and right edges. This control is most often used when the Layout type is set to Frame in the Layout tab.

**Direction**
This menu provides options for determining the Direction in which the text is to be written.

**Line Direction**
These menu options are used to determine the text flow from top to bottom, bottom to top, left to right, or right to left.

**Underline and Strikeout**
These buttons apply the addition of emphasis styles to the text.

**Write On**
This range control is used to quickly apply simple Write On and Write Off effects to the text. To create a Write On effect, animate the End portion of the control from 1 to 0 over the length of time required. To create a Write Off effect, animate the Start portion of the range control from 0 to 1.
**Advanced font controls**

**Force Monospaced**
This slider control can be used to override the kerning (spacing between characters) defined in the font. Setting this slider to zero (the default value) will cause Fusion to rely entirely on the kerning defined with each character. A value of one will cause the spacing between characters to be completely even, or monospaced.

**Use Font Defined Kerning**
This enables kerning as specified in the TrueType font and is on by default.

**Manual Font Kerning/Placement**
Right-clicking on this label will display a contextual menu that can be used to animate the kerning of the text. See the “Toolbar” section of this node later in this chapter for details on manual kerning.

**Tab Spacing**
The controls in the Tabs section are used to configure the horizontal screen positions of eight separate tab stops. Any tab characters in the text will conform to these positions.

You can add tabs directly in the Styled Text input as you type. You can also add tabs by copying from another document, such as Text on macOS or Notepad on Windows, and paste it into the text box.

**Position**
This control is used to set the horizontal position of the tab in the frame. The values range from -0.5 to 0.5, where 0 is the center. The position of the tab will be indicated in the viewer by a thin vertical white line when the Text node is selected. At the top of each tab line in the viewer is a handle. The handle can be used to position the tab manually.

**Alignment**
Each tab can be set either left aligned, right aligned, or centered. This slider ranges from -1.0 to 1.0, where -1.0 is a left-aligned tab, 0.0 is a centered tab and 1.0 is a right-aligned tab. Clicking the tab handles in the viewer will toggle the alignment of the tab among the three states.
The controls used to position the text are located in the Layout tab. One of four layout types can be selected using the Type drop-down menu.

- **Point**: Point layout is the simplest of the layout modes. Text is arranged around an adjustable center point.

- **Frame**: Frame layout allows you to define a rectangular frame used to align the text. The alignment controls are used for justifying the text vertically and horizontally within the boundaries of the frame.

- **Circle**: Circle layout places the text around the curve of a circle or oval. Control is offered over the diameter and width of the circular shape. When the layout is set to this mode, the Alignment controls determine whether the text is positioned along the inside or outside of the circle’s edge, and how multiple lines of text are justified.

- **Path**: Path layout allows you to shape your text along the edges of a path. The path can be used simply to add style to the text, or it can be animated using the Position on Path control that appears when this mode is selected.

**Center X, Y, and Z**
These controls are used to position the center of the layout element in space. X and Y are onscreen controls, and Center Z is a slider in the node controls.

**Size**
This slider is used to control the scale of the layout element.
Perspective
This slider control is used to add or remove perspective from the rotations applied by the Angle X, Y, and Z controls.

Rotation
Rotation consists of a series of buttons allowing you to select the order in which 3D rotations are applied to the text. Angle dials can be used to adjust the angle of the Layout element along any axis.

Width and Height
The Width control is visible when the Layout mode is set to Circle or Frame. The Height control is visible only when the Layout mode is set to Frame. Width and Height controls are used to adjust the dimensions and aspect of the Layout element.

Fit Characters
This menu control is visible only when the Layout type is set to Circle. This menu is used to select how the characters are spaced to fit along the circumference.

Position on Path
The Position on Path control is used to control the position of the text along the path. Values less than 0 or greater than 1 will cause the text to move beyond the path in the same direction as the vector of the path between the last two keyframes.

Background Color
The text generated by this node is normally rendered with a transparent background. This Color Picker control can be used to set a background color.

Right-Click Here for Shape Animation
This label appears only when the Layout type is set to Path. It is used to provide access to a contextual menu that provides options for connecting the path to other paths in the node tree, and animating the shape of the path over time.

For more information, see Chapter 11, “Animating with Motion Paths” in the Fusion Reference Manual or Chapter 72 in the DaVinci Resolve Reference Manual.
Transform Tab

The Transform tab is used to move, rotate, shear and scale text based on a character, word, or line.

Transform

The Transform menu is used to determine the portion of the text affected by the transformations applied in this tab. Transformations can be applied to line, word, and character levels simultaneously. This menu is only used to keep the visible controls to a reasonable number.

- **Characters**: Each character of text is transformed along its own center axis.
- **Words**: Each word is transformed separately on the word’s center axis.
- **Lines**: Each line of the text is transformed separately on that line’s center axis.

Spacing

The Spacing slider is used to adjust the space between each line, word, or character. Values less than 1 will usually cause the characters to begin overlapping.

Pivot X, Y, and Z

This provides control over the exact position of the axis. By default, the axis is positioned at the calculated center of the line, word, or character. The Axis control works as an offset, such that a value of 0.1, 0.1 in this control would cause the axis to be shifted downward and to the right for each of the text elements. Positive values in the Z-axis slider will move the axis of rotation further along the axis (away from the viewer). Negative values will bring the axis of rotation closer.

Rotation

These buttons are used to determine the order in which transforms are applied. X, Y, and Z would mean that the rotation is applied to X, then Y, and then Z.

X, Y, and Z

These controls can be used to adjust the angle of the text elements in any of the three dimensions.

Shear X and Y

Adjust these sliders to modify the slanting of the text elements along the X- and Y-axis.

Size X and Y

Adjust these sliders to modify the size of the text elements along the X- and Y-axis.
Shading Tab
The Shading tab provides controls to adjust the shading, texture, and softness of the text. Transformations can be controlled from this tab as well, applying additional transformations to as many as eight separate text shading elements independently.

Shading Element
The eight number values in the menu are used to select the element affected by adjustments in this tab.

Enabled
Select this checkbox to enable or disable each layer of shading elements. Element 1, which is the fill color, is enabled by default. The controls for a shading element will not be displayed unless this checkbox is selected.

Sort By
This menu allows you to sort the shading elements by number priority, with 1 being the topmost element and 8 being the bottommost element, or Z depth, based on the Z Position parameter.

Name
This text label can be used to assign a more descriptive name to each shading element you create.

Appearance
The four Appearance buttons determine how the shading element is applied to the text. Different controls will appear below depending on the appearance type selected.

- **Text Fill:** The shading element is applied to the entire text. This is the default mode.
- **Text Outline:** The shading element is drawn as an outline around the edges of the text.
- **Border Fill:** The shading element fills a border surrounding the text. Five additional controls are provided with this shading mode.
- **Border Outline:** The Border Outline mode draws an outline around the border that surrounds the text. It offers several additional controls.

Opacity
The Opacity slider controls the overall transparency of the shading element. It is usually better to assign opacity to a shading element than to adjust the Alpha of the color applied to that element.

Blending
This menu is used to select how the renderer deals with an overlap between two characters in the text.

- **Composite:** Merges the shading over the top of itself.
- **Solid:** Sets the pixels in the overlap region to opaque.
- **Transparent:** Sets the pixels in the overlap region to transparent.

Thickness
(Outline only) Thickness adjusts the thickness of the outline. Higher values equal thicker outlines.

Adapt Thickness to Perspective
(Outline only) Selecting this checkbox will cause your outline to become thinner where the text is farther away from the camera, and thicker where it is closer. This will create a more realistic outline for text transformed in 3D but takes significantly longer to render.
Outside Only
(Outline only) Selecting this checkbox will cause the outline to be drawn only on the outside edge of the text. By default, the outline is centered on the edge and partially overlaps the text.

Join Style
(Outline only) These buttons provide options for how the corners of the outline are drawn. Options include Sharp, Rounded, and Beveled.

Line Style
(Outline only) This menu offers additional options for the style of the line. Besides the default solid line, a variety of dash and dot patterns are available.

Level
(Border Fill only) This is used to control the portion of the text border filled.
- Text: This draws a border around the entire text.
- Line: This draws a border around each line of text.
- Word: This draws a border around each word.
- Character: This draws a border around each character.

Extend Horizontal and Extend Vertical
(Border only) Use this slider to change the dimensions of each border.

Round
(Border Fill and Border Outline only) This slider is used to round off the edges of the border.

Color Types
Besides solid shading, it is also possible to use a gradient fill or map an external image onto the text. This menu is used to determine if the color of the shading element is derived from a user-selected color or gradient, or if it comes from an external image source. Different controls will be displayed below depending on the Color Type selected.
- Solid: When the Type menu is set to Solid mode, color selector controls are provided to select the color of the text.
- Image: The output of a node in the node tree will be used to texture the text. The node used is chosen using the Color Image control that is revealed when this option is selected.
- Gradient: When the Type menu is set to Gradient, additional controls are displayed where the gradient colors can direction can be customized.

Using the Gradient Color Bar
The gradient color bar is used to select the colors for the gradient. The default two color stops set the start and end colors. You can change the colors used in the gradient by selecting the color stop, and then using the Eyedropper or color swatch to set a new color.

You can add, move, copy and delete color using the gradient bar.
To modify one of the colors, select the triangle below the color on the bar.

**To add a color stop to the gradient bar:**
1. Click anywhere along the bottom of the gradient bar.
2. Use the Eyedropper or color swatch to select the color for the color stop.

**To move a color stop on the gradient bar:**
- Drag a color stop left or right along the bar.

**To copy a color stop:**
- Hold Command (macOS) or Ctrl (Windows) while you drag a color stop.

**To delete a color stop:**
- Drag the color stop up past the gradient bar.

---

**Image Source**
(Image Mode only) The Image Source menu includes three options for acquiring the image used to fill the text.
- **Tool:** Displays a Color image text field where you can add a tool from the node tree as the fill for text.
- **Clip:** Provides a Browse button to select a media file from your hard drive as the fill for text.
- **Brush:** Displays a Color Brush menu where you can select one of Fusion's paint brush bitmaps as the fill for text.

**Color Image/Color Brush**
(Image Mode only) The Color Image text box and Color Brush menu are used to select the tool or paint brush that will fill the text. In the Color Image text box, enter the name of the node in the node tree that will provide the image. You can type the name in with the keyboard, drag the node from the node tree into the text box, or right-click and select Connect To from the contextual menu to select the image to be used. For the Color Brush, select the Brush from the menu.

**Image Sampling**
(Image Mode only) This menu is used to select the sampling type for shading rendering and transformations. The default of Pixel shading is sufficient for 90% of tasks. To reduce detectable aliasing in the text, set the sampling type to Area. This is slower but may produce better-quality results. A setting of None will render faster, but with no additional sampling applied so the quality will be lower.

**Image Edges**
(Image Mode only) This menu is used to choose how transformations applied to image shading elements are handled when they wrap off the text’s edges.

**Shading Mapping**
(Image Mode only) This menu is used to select whether the entire image is stretched to fill the text or scaled to fit, maintaining the aspect ratio but cropping part of the image as needed.

**Mapping Angle**
(Image and Gradient Modes only) This control rotates the image or gradient on the Z-axis.

**Mapping Size**
(Image and Gradient Modes only) This control scales the image or gradient.
**Mapping Aspect**  
(Image and Gradient Modes only) This control vertically stretches or shrinks the image or gradient.

**Mapping Level**  
(Image and Gradient Modes only) The Mapping Level menu is used to select how the image is mapped to the text.

- **Full Image:** Applies the entire image to the text.
- **Text:** Applies the image to fit the entire set of text.
- **Line:** Applies the image per line of text.
- **Word:** Applies the image per each word of text.
- **Character:** Applies the image per individual character.

**Softness X and Y**  
These sliders control the softness of the text outline used to create the shading element. Control is provided for the X- and Y-axis independently.

**Apply Softness to Fill Color**  
Selecting this checkbox will cause blur (softness) to be applied to the shading element. The effect is best seen when applied to a shading element using an external image.

**Softness Glow**  
This slider will apply a glow to the softened portion of the shading element.

**Softness Blend**  
This slider controls the amount that the result of the softness control is blended back with the original. It can be used to tone down the result of the soften operation.

**Priority Back/Front**  
Only enabled when the Sort By menu is set to Priority, this slider overrides the priority setting and determines the layer’s order for the shading elements. Slide the control to the right to bring an element closer to the front. Move it to the left to tuck one shading element behind another.

**Offset X, Y, and Z**  
These controls are used to apply offset from the text’s global center (as set in the Layout tab) for the shading elements. A value of X0.0, Y0.1 in the coordinate controls would place the shading element centered with 10 percent of the image further down the screen along the Y-axis. Positive values in the Z-Offset slider control will push the center further away from the camera, while positive values will bring it closer to the camera.

**Pivot X, Y, and Z**  
These controls are used to set the exact position of the axis for the currently selected shading element. By default, the axis is positioned at the calculated center of the line, word, or character. The axis control works as an offset, such that a value of 0.1, 0.1 in this control would cause the axis to be shifted downward and to the right for the shading element. Positive values in the Z-axis slider will move the axis of rotation further along the axis (away from the viewer). Negative values will bring the axis of rotation closer.

**Rotation X, Y, and Z**  
These controls are used to adjust the angle of the currently selected shading element in any of the three dimensions.
**Shear X and Y**
Adjust these sliders to modify the slanting of the currently selected shading element along the X and Y axis.

**Size X and Y**
Adjust these sliders to modify the size of the currently selected shading element along the X and Y axis.

**Common Controls**

**Image and Settings Tabs**
The Image and Settings tabs in the Inspector are duplicated in many Generator nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

**Text+ Toolbar**
When the Text node is selected, a toolbar will appear in the viewer. Each button is described below from left to right.

**Allow Typing in Viewer**
When selected, you can type and edit text directly in the viewer. Clicking on the text in the viewer will move the insert cursor within the text. Left and Right Arrow keys will move the insert cursor between characters. Using the Up and Down Arrows will move between text lines.

**Allow Manual Kerning**
The Manual Kerning button overrides the automatic kerning normally applied to text. Clicking the small red handle at the bottom of any character selects the character for kerning. You can also draw a selection rectangle around the characters you want to kern. Once any characters are selected, hold down the Option (macOS) or Alt key (Windows) while pressing the Left or Right Arrow key to make small adjustments to the kerning of the selected characters. Hold the Alt + Shift (Windows) or Option + Shift (macOS) keys down while pressing arrow keys to move the character in larger increments.

To animate the position of each character, right-click on the control label Manual Font Kerning in the Inspector’s Advanced Controls and select Animate from the contextual menu. A new key will be set on the animation spline each time a character is moved. All characters are animated with the same spline, as with polyline mask animation.

**No Text Outline**
When this button is selected, it disables the drawing of any outline around the edges of the text. The outline is not a part of the text; it is an onscreen control used to help identify the position of the text. This is a three-way toggle with the Text Outline Outside Frame Only, and Show Always Text Outline buttons.

**Text Outline Outside Frame Only**
This button draws an outline around the edges of text, which is outside the visible frame. This is useful for locating text that has moved offscreen and is no longer rendering a visible result. This is a three-way toggle with the No Text Outline, and Show Always Text Outline buttons.
Show Always Text Outline
This button draws an outline around the edges of text, whether or not the text is visible within the frame. This is a three-way toggle with the No Text Outline, and Text Outline Outside Frame Only buttons.

Common Controls
Image and Settings Tabs
The Image and Settings tabs in the Inspector are duplicated in many Generator nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

Text+ Modifiers
Text+ modifiers can be assigned by right-clicking in the Styled Text box and selecting a modifier from the contextual menu. Once a modifier is selected, its controls are found in the Modifiers tab at the top of the Inspector.

Character Level Styling
The Character Level Styling modifier works only on Text+ nodes. Once applied, individual characters can be selected directly in the viewer, and different text attributes can be applied to them using the controls in the Modifiers tab.

NOTE: Character Level Styling can only be directly applied to Text+ nodes, not to Text 3D nodes. However, styled text from a Text+ node can be applied to a Text 3D node by copying the Text+, right-clicking on the Text 3D, and choosing Paste Settings.
Inspector

Text Tab
The Styled Text box in the Modifiers tab displays the same text in the Tools tab of the Text+ Inspector. However, individual characters you want to modify cannot be selected in the Styled Text box; they must be selected in the viewer. Once text is selected in the viewer, the Text tab includes familiar text formatting options that will apply only to the selected characters.

Clear Character Styling on Selection
All changes made to the currently selected characters will be reset.

Clear All Character Styling
All character attributes will be reset to their original values.

Transform Tab and Shading Tab
For details on these Text+ tabs, see the “Text+” section above.

Comp Name
The Comp Name sets the styled text to become the current Composition Name. This is quite useful to automate burn-ins for daily renderings. See also the TimeCode modifier. It can be applied by right-clicking in the Styled Text field of a Text+ node and selecting Comp Name.

Controls
This modifier has no controls.

Follower
The Follower modifier allows sequencing text animations. The modifier is applied by right-clicking in the Styled Text field of a Text+ node and selecting Follower. In the Modifiers tab, you start by animating the parameters of the text (note that changing any parameter in the Modifiers tab will not be visible unless a keyframe is added.) Then, in the Timing tab you set the animation’s delay between characters.
**Inspector**

**Timing Tab**
Once the text is animated using the controls in the Modifiers tab, the Timing tab is used to choose the direction and offset of the animation.

**Range**
The Range menu is used to select whether all characters should be influenced or only a selected range. To set the range, you can drag-select over the characters directly in the viewer.

**Order**
The Order menu determines in which direction the characters are influenced. Notice that empty spaces are counted as characters as well. Available options include:

- **Left to right**: The animation ripples from left to right through all characters.
- **Right to left**: The animation ripples from right to left through all characters.
- **Inside out**: The animation ripples symmetrically from the center point of the characters toward the margin.
- **Outside in**: The animation ripples symmetrically from the margin toward the center point of the characters.
- **Random but one by one**: The animation is applied to randomly selected characters but only influences one character at a time.
- **Completely random**: The animation is applied to randomly selected characters, influencing multiple characters at a time.
- **Manual curve**: The affected characters can be specified by sliders.

**Delay Type**
Determines what sort of delay is applied to the animation. Available options include:

- **Between Each Character**: The more characters there are in your text, the longer the animation will take to the end. A setting of 1 means the first character starts the animation, and the second character starts 1 frame later, the third character starts 1 frame after the second, and so on.
- **Between First and Last Character**: No matter how many characters are in your text, the animation will always be completed in the selected amount of time.

**Clear All Character Styling**
All character attributes will be reset to their original values.

**Text Controls, Alignment, Transform, and Shading Tabs**
In these tabs, the actual animation for the characters is done. Observe that simply changing a value in these tabs will have no influence at all. The value must be animated for the effect to show.

For a detailed description on the various parameters, see the Text+ node documentation.
Text Scramble

The Text Scramble randomly replaces the characters with others from a user definable set. It can be applied by right-clicking into the Styled Text field of a Text+ node and selecting Text Scramble.

The Controls for the Text Scramble are then adjusted in the Modifiers tab.

Inspector

![Text Scramble modifier Controls tab](image)

Controls Tab

The Controls tab in the Text Scramble modifier is used to enter text and scramble it using the Randomness control. The scrambled characters are taken from the Substitute Chars field at the bottom of the Inspector.

Randomness

Defines how many characters are exchanged randomly. A value of 0 will change no characters at all. A value of 1 will change all characters in the text. Animating this thumbwheel to go from 0 to 1 will gradually exchange all characters.

Input Text

This reflects the original text in the Text+ Styled Text field. Text can be entered either here or in the Text+ node.

Animate on Time

When enabled, the characters are scrambled randomly on every new frame. This switch has no effect when Randomness is set to 0.

Animate on Randomness

When enabled, the characters are scrambled randomly on every new frame, when the Randomness thumbwheel is animated.

This switch has no effect when Randomness is set to 0.

Don't Change Spaces

When enabled, spaces are not scrambled, allowing the length of the single words to stay the same, although their characters get scrambled around.

Substitute Chars

This field contains the characters used to scramble the text.
**Text Timer**

The Text Timer makes the Text+ node either a Countdown, a Timer, or a Clock. This is useful for onscreen real-time displays or to burn in the creation time of a frame into the picture. It can be applied by right-clicking in the Styled Text field of a Text+ node and selecting Text Timer.

**Inspector**

![Text Timer modifier Controls tab](image)

**Controls Tab**

The Controls tab for the Text Timer modifier is used to set up the type of time display that is generated by this modifier.

**Mode**

This menu sets the mode the timer is working in. The choices are CountDown, Timer, and Clock. In Clock mode, the current system time will be displayed.

**Hrs, Mins, Secs (Checkboxes)**

Defines which parts of the clock should be shown onscreen.

**Hrs, Mins, Secs (Sliders)**

Sets the start time for the CountDown and Timer mode.

**Start**

Starts the Counter or Timer. Toggles to Stop once the timer is running.

**Reset**

Resets the Counter and Timer to the values set by the sliders.

**Time Code**

The Time Code only works on Text+ nodes. It sets the Styled text to become a counter based on the current frame. This is quite useful for automating burn-ins for daily renderings.

It can be applied by right-clicking in the Styled Text field of a Text+ node and selecting Time Code.

**Inspector**

![Time Code modifier Controls tab](image)
Controls Tab
The Controls tab for the Time Code modifier is used to set up the time code display that is generated by this modifier.

Hrs, Mins, Secs, Frms, Flds
Activate or deactivate these options to customize the time code display to show hours, minutes, seconds, frames, and fields, respectively. Activating frames will only give you a plain frame counter.

Start Offset
Introduce a positive or negative offset to Fusion’s current time to match up with existing time codes.

Frames per Second
This should match with your composition’s FPS setting to provide accurate time measurement.

Drop Frame
Activate this checkbox to match the time code with footage that has drop frames—for example, certain NTSC formats.

The Common Controls
Nodes that generate images share a number of identical controls in the Inspector. This section describes controls that are common among Generator nodes.

Inspector

Image Tab
The controls in this tab are used to set the resolution, color depth, and pixel aspect of the image produced by the node.

Process Mode
Use this menu control to select the Fields Processing mode used by Fusion to render changes to the image. The default option is determined by the Has Fields checkbox control in the Frame Format preferences.
Global In and Out
Use this control to specify the position of this node within the project. Use Global In to specify which frame that starts the clip and Global Out to specify which frame ends the clip (inclusive) within the project’s Global Range.

The node will not produce an image on frames outside this range.

Use Frame Format Settings
When this checkbox is selected, the width, height, and pixel aspect of the image created by the node will be locked to values defined in the composition’s Frame Format preferences. If the Frame Format preferences change, the resolution of the image produced by the node will change to match. Disabling this option can be useful to build a composition at a different resolution than the eventual target resolution for the final render.

Width/Height
This pair of controls is used to set the Width and Height dimensions of the image to be created by the node.

Pixel Aspect
This control is used to specify the Pixel Aspect ratio of the created images. An aspect ratio of 1:1 would generate a square pixel with the same dimensions on either side (like a computer display monitor), and an aspect of 0.9:1 would create a slightly rectangular pixel (like an NTSC monitor).

NOTE: Right-click on the Width, Height, or Pixel Aspect controls to display a menu listing the file formats defined in the preferences Frame Format tab. Selecting any of the listed options will set the width, height, and pixel aspect to the values for that format, accordingly.

Depth
The Depth drop-down menu is used to set the pixel color depth of the image created by the Creator node. 32-bit pixels require 4X the memory of 8-bit pixels but have far greater color accuracy. Float pixels allow high dynamic range values outside the normal 0…1 range, for representing colors that are brighter than white or darker than black.

Source Color Space
You can use the Source Color Space menu to set the Color Space of the footage to help achieve a linear workflow. Unlike the Gamut tool, this doesn’t perform any actual color space conversion, but rather adds the source space data into the metadata, if that metadata doesn’t exist. The metadata can then be used downstream by a Gamut tool with the From Image option, or in a Saver, if explicit output spaces are defined there. There are two options to choose from:

– **Auto**: Automatically reads and passes on the metadata that may be in the image.

– **Space**: Displays a Color Space Type menu where you can choose the correct color space of the image.

Source Gamma Space
Using the Curve type menu, you can set the Gamma Space of the footage and choose to remove it by way of the Remove Curve checkbox when working in a linear workflow. There are three choices in the Curve type menu:

– **Auto**: Automatically reads and passes on the metadata that may be in the image.

– **Space**: Displays a Gamma Space Type menu where you can choose the correct gamma curve of the image.

– **Log**: Brings up the Log/Lin settings, similar to the Cineon tool. For more information, see Chapter 38, “Film Nodes” in the Fusion Reference Manual or Chapter 99 in the DaVinci Resolve Reference Manual.
Remove Curve
Depending on the selected Gamma Space or on the Gamma Space found in Auto mode, the Gamma Curve is removed from, or a log-lin conversion is performed on, the material, effectively converting it to a linear output space.

Fast Noise Image Tab Options
The following controls are specific to the Image tab in the Fast Noise Node.

Mask Map Inputs
These external connections allow you to use masks to control the value of the Noise Detail and Brightness controls individually for each pixel. This can allow some interesting and creative effects.

Noise Detail Map
A soft-edged mask connected to the Noise Detail Map will give a flat noise map (zero detail) where the mask is black, and full detail where it is white, with intermediate values smoothly reducing in detail. It is applied before any gradient color mapping. This can be very helpful for applying maximum noise detail in a specific area, while smoothly falling off elsewhere.

Noise Brightness Map
A mask connected to this input can be used to control the noise map completely, such as boosting it in certain areas, combining it with other textures, or if Detail is set to 0, replacing the Perlin Noise map altogether.

Settings Tab
The Settings Tab in the Inspector can be found on every tool in the Color category. The Settings controls are even found on third-party Color-type plug-in tools. The controls are consistent and work the same way for each tool, although some tools do include one or two individual options, which are also covered here.

![Common Generator settings](image)
Blend
The Blend control is used to blend between the tool’s original image input and the tool’s final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming. Normally, this will cause the tool to skip processing entirely, copying the input straight to the output.

Process When Blend Is 0.0
The tool is processed even when the input value is zero. This can be useful if processing of this node is scripted to trigger another task, but the value of the node is set to 0.0.

Red/Green/Blue/Alpha Channel Selector
These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.

For example, if the red button on a Blur tool is deselected, the blur will first be applied to the image, and then the red channel from the original input will be copied back over the red channel of the result.

There are some exceptions, such as tools for which deselecting these channels causes the tool to skip processing that channel entirely. Tools that do this will generally possess a set of identical RGBA buttons on the Controls tab in the tool. In this case, the buttons in the Settings and the Controls tabs are identical.

Apply Mask Inverted
Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

Multiply by Mask
Selecting this option will cause the RGB values of the masked image to be multiplied by the mask channel’s values. This will cause all pixels of the image not in the mask (i.e., set to 0) to become black/transparent.

Use Object/Use Material (Checkboxes)
Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports Object ID and Material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels will be used if present. The specific Material ID or Object ID affected is chosen using the next set of controls.

Correct Edges
This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information on the Coverage and Background Color channels, see Chapter 18 “Understanding Image Channels” in the Fusion Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.

Object ID/Material ID (Sliders)
Use these sliders to select which ID will be used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker: to grab IDs from the image displayed in the view. The image or sequence must have been rendered from a 3D software package with those channels included.
Motion Blur

- **Motion Blur**: This toggles the rendering of Motion Blur on the tool. When this control is toggled on, the tool’s predicted motion is used to produce the motion blur caused by the virtual camera’s shutter. When the control is toggled off, no motion blur is created.

- **Quality**: Quality determines the number of samples used to create the blur. A quality setting of 2 will cause Fusion to create two samples to either side of an object’s actual motion. Larger values produce smoother results but increase the render time.

- **Shutter Angle**: Shutter Angle controls the angle of the virtual shutter used to produce the motion blur effect. Larger angles create more blur but increase the render times. A value of 360 is the equivalent of having the shutter open for one whole frame exposure. Higher values are possible and can be used to create interesting effects.

- **Center Bias**: Center Bias modifies the position of the center of the motion blur. This allows the creation of motion trail effects.

- **Sample Spread**: Adjusting this control modifies the weighting given to each sample. This affects the brightness of the samples.

Use GPU

The user GPU menu has three settings. Setting the menu to Disable turns off hardware-accelerated rendering using the graphics card in your computer. Enabled uses the hardware, and Auto uses a capable GPU if one is available and falls back to software rendering when a capable GPU is not available.

Comments

The Comments field is used to add notes to a tool. Click in the field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

Scripts

Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
Chapter 105

I/O Nodes

This chapter details the input and output of media using Loader and Saver nodes within Fusion Studio as well as the MediaIn and MediaOut nodes in DaVinci Resolve.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

Contents

- Loader Node [LD] 2014
- MediaIn Node [MI] 2022
- MediaOut Node [MO] 2026
- Saver Node [SV] 2027
- The Common Controls 2034
Loader Node [LD]

Loader Node Introduction

**NOTE:** The Loader node in DaVinci Resolve is only used for importing EXR files.

When using Fusion Studio, the Loader node is the node you use to select and load footage from your hard drive into the Node Editor. There are three ways to add a Loader node, and consequently a clip, to the Node Editor.

- Add the Loader from the Effects Library or toolbar (Fusion Studio only), and then use Loader’s file browser to bring a clip into the Node Editor.
- Drag clips from an OS window directly into the Node Editor, creating a Loader node in the Node Editor.
- Choose File > Import > Footage (Fusion Studio only), although this method creates a new composition as well as adds the Loader node to the Node Editor.

When a Loader is added to the Node editor, a File dialog is displayed automatically to allow the selection of a clip from your hard drives.

**NOTE:** You can disable the automatic display of the file browser by disabling Auto Clip Browse in the Global > General Preferences.

Once clips are brought in using the Loader node, the Loader is used for trimming, looping, and extending the footage, as well as setting the field order, pixel aspect, and color depth. The Loader is arguably the most important tool in Fusion Studio.

Inputs

The single input on the Loader node is for an effect mask to crop the image brought in by the Loader.

- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the loaded image to appear only within the mask. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

The Loader node is a 2D image of any format supported in Fusion Studio. It is limited to an EXR format in DaVinci Resolve. Below, the LOADER imports an image, which is then masked using an Ellipse matte. The output of the masked LOADER is passed onto 2D image-processing nodes.
A Loader node used for importing images

Inspector

File Tab
The File tab for the Loader includes controls for trimming, creating a freeze frame, looping, and reversing the clip. You can also reselect the clip that the Loader links to on your hard drive.

Global In and Out
The Global In and Out handles are used to specify the position of this node within the project. Use Global In to specify the frame on which the clip starts and use Global Out to specify the frame on which the clip ends within the project’s global range. The node does not produce an image on frames outside of this range.

If the Global In and Out values are decreased to the point where the range between the In and Out values is smaller than the number of available frames in the clip, Fusion automatically trims the clip by adjusting the Trim range control. If the Global In/Out values are increased to the point where the range between the In and Out values is larger than the number of available frames in the clip, Fusion automatically lengthens the clip by adjusting the Hold First/Last Frame controls. Extended frames are visually represented in the range control by changing the color of the held frames to green in the control.

To slide the clip in time or move it through the project without changing its length, place the mouse pointer in the middle of the range control and drag it to the new location, or enter the value manually in the Global In value box.

Filename
The Filename field shows the file path of the clip imported to the Node Editor by the Loader node. Clicking on the Browse button opens a standard file browser. The path to the footage can also be typed directly using the field provided. The text box supports filename completion. As the name of a directory or file is typed in the text box, Fusion displays a pop-up that lists possible matches. Use the arrow keys to select the correct match and complete the path.
NOTE: Loading image sequences is common practice for compositing, whether the image sequence comes from a 3D renderer or a digital cinema camera. If the last part of a file's name is a number (not counting the file extension), Fusion automatically scans the directory looking for files that match the sequence. For example, the following filenames would be valid sequences:

image.0001.braw, image.0002.braw, image.0003.braw …
or

image151.exr, image152.exr, image153.exr …

The following would not be considered a sequence since the last characters are not numeric.

shot.1.fg.jpg, shot.2.fg.jpg, shot.3.fg.jpg

It is not necessary to select the first file in the sequence. Fusion searches the entire folder for files matching the sequence in the selected filename. Also, Fusion determines the length of the sequence based on the first and last numeric value in the filenames. Missing frames are ignored. For example, if the folder contains two files with the following names:

image.0001.exr, image.0100.exr

Fusion sees this as a file sequence with 100 frames, not an image sequence containing two frames. The Missing Frames drop-down menu is used to choose how Fusion handles missing frames.

The Trim In/Trim Out control's context menu can also be used to force a specific clip length or to rescan the folder. Both controls are described in greater detail below.

Occasionally, you want to load only a single frame out of a sequence—e.g., a photograph from a folder containing many other files as well. By default, Fusion detects those as a sequence, but if you hold Shift while dragging the file from the OS window to the Node Editor, Fusion takes only that specific file and disregards any sequencing.

Proxy Filename

The Proxy Filename control only appears once the filename control points to a valid clip. The Proxy Filename can specify a clip that is loaded when the Proxy mode is enabled. This allows smaller versions of the image to be loaded to speed up file I/O from disk, and processing. For example, create a 1/4-scale version of an 8K EXR sequence to use as EXR proxy files. Whenever the Proxy mode of the Composition is enabled, the smaller resolution proxy clip is loaded from disk, and all processing is performed at the lower resolution, significantly improving render times. This is particularly useful when working with large RAW plates stored on a remote file server. Lower-resolution versions of the plates can be stored locally, reducing network bandwidth, interactive render times, and memory usage. The proxy clip must have the same number of frames as the source clip, and the sequence numbers for the clip must start and end on the same frame numbers. It is strongly suggested that the proxies are the same format as the main files. In the case of formats with options, such as Cineon, DPX, and OpenEXR, the proxies use the same format options as the primary.

Trim

The Trim range control is used to trim frames from the start or end of a clip. Adjust the Trim In to remove frames from the start and adjust Trim Out to specify the last frame of the clip. The values used here are offsets. A value of 5 in Trim In would use the fifth frame in the sequence as the start, ignoring the first four frames. A value of 95 would stop loading frames after the 95th.
**Hold First Frame/Hold Last Frame:**
The Hold First Frame and Hold Last Frame controls hold the first or last frame of the clip for the specified amount of frames. Held frames are included in a loop if the footage is looped.

**Reverse**
Select this checkbox to reverse the footage so that the last frame is played first, and the first frame is played last.

**Loop**
Select this checkbox to loop the footage until the end of the project. Any lengthening of the clip using Hold First/Last Frame or shortening using Trim In/Out is included in the looped clip.

**Missing Frames**
The Missing Frames menu determines the Loader behavior when a frame is missing or is unable to load for any reason.

- **Fail:** The Loader does not output any image unless a frame becomes available. Rendering is aborted.
- **Hold Previous Output:** The last valid frame is held until a frame becomes available again. This fails if no valid frame has been seen—for example, if the first frame is missing.
- **Output Black:** Outputs a black frame until a valid frame becomes available again.
- **Wait:** Fusion waits for the frame to become available, checking every few seconds. This is useful for rendering a composition simultaneously with a 3D render. All rendering ceases until the frame appears.

---

**The Magic Comp Variable**
Loaders and Savers use the absolute file paths for the location of media. However, if you are using Fusion Studio, you can use a file path that is relative to the saved composition location. The Comp variable works for Loaders and Savers and helps you to keep your work organized. Entering Comp:\ in place of the full file path name is a shortcut for the folder where your Fusion composition document is saved.

You can either enter the Comp:\ manually into the filename field of a Loader, or turn on the Enable Reverse Mapping of Paths Preferences checkbox in the Path Map preferences. Enabling the Path Map preference check box will use the Comp:\ automatically.

So as long as all your source footage is stored in subfolders of your Comp folder, Fusion finds that footage regardless of the actual hard drive or network share name.

You could, for example, copy an entire shot from the network to your local drive, set up your Loaders and Savers to use the Comp variable, work all your magic locally (i.e., set up your composition), and then copy just the composition back to the server and issue a net-render. All render slaves automatically find the source footage.

**Some examples:**

Your composition is stored in:

```
X:\Project\Shot0815\Fusion\Shot0815.comp
```

Your source footage sits in:

```
X:\Project\Shot0815\Fusion\Greenscreen\0815Green_0000.dpx
```
The relative path in the Loader node would then be:

```
Comp\Greenscreen\0815Green_0000.dpx
```

If your source footage is stored in:

```
X:\Project\Shot0815\Footage\Greenscreen\0815Green_0000.dpx
```

The relative path in the Loader node would then be:

```
Comp\..\Footage\Greenscreen\0815Green_0000.dpx
```

Observe how the two dots .. set the directory to go up one folder, much like CD .. in a Command Shell window.

---

**Import Tab**

The Import tab includes settings for the frame format and how to deal with fields, pixel aspect, 3:2 pull down/pull up conversion, and removing gamma curve types for achieving a linear workflow.

**Process Mode**

Use this menu to select the Fields Processing mode used by Fusion when loading the image. The Has Fields checkbox control in the Frame Format preferences determines the default option, and the default height as well. Available options include:

- Full frames
- NTSC fields
- PAL/HD fields
- PAL/HD fields (reversed)
- NTSC fields (reversed).

The two reversed options load fields in the opposite order and thus result in the fields being spatially swapped both in time order and in vertical order as well.

Use the Swap Field Dominance checkbox (described below) to swap fields in time only.
Depth
The Depth menu is used to select the color depth used to process footage from this Loader. The default option is Format.

- **Format**: The color depth is determined by the color depth supported in the file format loaded. For example, JPEG files automatically process at 8 bit because the JPEG file format does not store color depths greater than 8. EXR files load at Float. If the color depth of the format is undetermined, the default depth defined in the Frame Format preferences is used. Formats that support multiple color depths are set to the appropriate color depth automatically.
- **Default**: The color depth is determined by the settings in the composition’s Frame Format Preferences panel.
- **Int 8 Bit/Int 16 Bit/Float 16/Float 32**: These options set the color depth for processing the image.

Pixel Aspect
This menu is used to determine the image’s pixel aspect ratio.

- **From File**: The loader conforms to the image aspect detected in the saved file. There are a few formats that can store aspect information. TIFF, JPEG, and OpenEXR are examples of image formats that may have the pixel aspect embedded in the file’s header. When no aspect ratio information is stored in the file, the default frame format method is used.
- **Default**: Any pixel aspect ratio information stored in the header of the image file is ignored. The pixel aspect set in the composition’s frame format preferences is used instead.
- **Custom**: Select this option to override the preferences and set a pixel aspect for the clip manually. Selecting this button causes the X/Y Pixel Aspect control to appear.

Custom Pixel Aspect
This control is visible only when Custom is selected from the Pixel Aspect menu. Enter the desired X and Y aspect or right-click on the control to display a menu of common frame formats and their aspects.

Import Mode
This menu provides options for removing pull-up from an image sequence. Pull-up is a reversible method of combining frames used to convert 24 fps footage into 30 fps. It is commonly used to broadcast NTSC versions of films.

- **Normal**: This passes the image without applying pull-up or pull-down 2:3.
- **Pull Up**: This removes existing 3:2 pull-down applied to the image sequence, converting from 30 fps to 24 fps 2:3.
- **Pull Down**: The footage has pull-down applied, converting 24 fps footage to 30 fps by creating five frames out of every four. The process mode of a Loader set to Pull Down should always be Full Frames.

First Frame
This menu appears when the Import Mode is set to either Pull Up or Pull Down. It is used to determine which frame of the 3:2 sequence is used as the first frame of the loaded clip.

Detect Pull-Down Sequence
This button is used to detect and set the pull-up sequence of the footage automatically. It only works if Pull-Up or Pull-Down is first selected from the Import Mode menu. If it succeeds in detecting the order, the First Frame control automatically sets to the correct value.
**Make Alpha Solid**
When enabled, the original Alpha channel of the clip is cleared and set to solid white (completely opaque).

**Invert Alpha**
When enabled, the original Alpha channel of the clip is inverted. This may also be used in conjunction with Make Alpha Solid to set the Alpha to pure black (completely transparent).

**Post-Multiply by Alpha**
Enabling this option causes the color value of each pixel to be multiplied by the Alpha channel for that pixel. This option can be used to convert subtractive (non-premultiplied) images to additive (premultiplied) images.

**Swap Field Dominance**
When enabled, the field order (dominance) of the image is swapped, so the order in time the fields appear is reversed. Unlike the Process Mode control, this is done without spatially swapping the scanlines in the image.

**Color Space Type**
This menu is used to set the Color Space of the footage to help achieve a linear color space workflow. Unlike the Gamut tool, this doesn't perform any actual color space conversion, but instead adds the source color space data into the metadata, if that metadata doesn't already exist. The metadata can then be used downstream by a Gamut tool with the From Image option, or in a Saver if explicit output spaces are defined there.

- **Auto:** Passes along any metadata that might be in the incoming image.
- **Space:** Allows the user to set the color space based on the recording device used to capture content or software settings used when rendering the content in another application.

**Curve Type**
This menu is used to determine the gamma curve of the footage. Once the Gamma Curve Type is set, you can choose to remove the curve to help achieve a linear workflow.

- **Auto:** Passes along any metadata that might be in the incoming image.
- **Space:** Allows the user to set the gamma curve based on the recording device used to capture content or software settings used when rendering the content in another application.
- **Log:** Displays the Log/Lin settings, similar to the Cineon Log node. For more information on the Log settings, refer to Chapter 38, “Film Nodes” in the Fusion Reference Manual or Chapter 99 in the DaVinci Resolve Reference Manual.

**Remove Curve**
Depending on the selected Curve Type or on the Gamma Space found in Auto mode, the associated Gamma Curve is removed from, or a log-lin conversion is performed on, the material, effectively converting it to a linear output space.
Format Tab

The Format tab contains file format-specific controls that dynamically change based on the selected Loader and the file it links to. Some formats contain a single control or no controls at all. Others like Camera RAW formats contain RAW-specific debayering controls. A partial format list is provided below for reference.

- **OpenEXR**: EXR provides a compact and flexible format to support high dynamic range images (float). The format also supports a variety of extra channels and metadata. The Format tab for OpenEXR files provides a mechanism for mapping any non-RGBA channels to the channels supported natively in Fusion. Using the Format tab, you can enter the name of a channel contained in the OpenEXR file into any of the edit boxes next to the Fusion channel name. A command line utility for dumping the names of the channels can be found at https://www.openexr.com.

- **QuickTime**: QuickTime files can potentially contain multiple tracks. Use the format options to select one of the tracks.

- **Cinema DNG**: CinemaDNG is an open format capable of high-resolution raw image data with a wide dynamic range. It was one of the formats recorded by Blackmagic Design cameras before switching over to the BRAW format.

- **Photoshop PSD Format**: Fusion can load any one of the individual layers stored in the PSD file, or the completed image with all layers. Transformation and adjustment layers are not supported. To load all layers in a PSD file with appropriate blend modes, use File > Import > PSD.

Common Controls

Settings Tab

The Settings tab controls are common to both Loader and Saver nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.
MediaIn Node Introduction

**NOTE:** The MediaIn node is only available in DaVinci Resolve.

The MediaIn node is the foundation of every composition you create in DaVinci Resolve’s Fusion page. In most cases, it replaces the Loader node used in Fusion Studio for importing clips. There are four ways to add a MediaIn node to the Node Editor:

- In the Edit or Cut page, position the playhead over a clip in the Timeline, and then click the Fusion page button. The clip from the Edit or Cut page Timeline is represented as a MediaIn node in the Node Editor.
- Drag clips from the Media Pool into the Node Editor, creating a MediaIn node in the Node Editor.
- Drag clips from an OS window directly into the Node Editor, creating a MediaIn node in the Node Editor.
- Choose Fusion > Import > PSD when importing PSD files into the Node Editor. Each PSD layer is imported as a separate MediaIn node.

**NOTE:** Although a MediaIn tool is located in the I/O section of the Effects Library, it is not used as a method to import clips.

When clips are brought in from the Media Pool, dragged from the OS window, or via the Import PSD menu option, you can use the MediaIn node’s Inspector for trimming, looping, and extending the footage, as well as setting the source’s color and gamma space.

**Inputs**

The single input on the MediaIn node is for an effect mask to crop the image brought in by the MediaIn.

- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the source image to appear only within the mask. An effects mask is applied to the tool after the tool is processed.

**Basic Node Setup**

The MediaIn node is typically the starting point for all composites done in the Fusion page of DaVinci Resolve. It contains the clip from the Edit page or Cut page. Any clip brought in from the Media Pool is also added as a MediaIn node.
When brought in from the Media Pool or dragged from an OS window, the MediaIn node’s Image tab includes controls for trimming, creating a freeze frame, looping, and reversing the clip. You can also reselect the clip the MediaIn links to on your hard drive. A subset of these controls is available when the MediaIn node is brought in from the Edit or Cut page Timeline.

Global In and Out

Only used when a clip is brought in through the Media Pool or an OS window, the Global In and Out handles are used to specify the start and end of this node within the Fusion effect. Use Global In to specify the frame on which the clip starts and use Global Out to specify the frame on which the clip ends within the comp’s global range. The node does not produce an image on frames outside of this range.

If the Global In and Out values are decreased to the point where the range between the In and Out values is smaller than the number of available frames in the clip, Fusion automatically trims the clip by adjusting the Trim range control. If the Global In/Out values are increased to the point where the range between the In and Out values is larger than the number of available frames in the clip, Fusion automatically lengthens the clip by adjusting the Hold First/Last Frame controls. Extended frames are visually represented in the range control by changing the color of the held frames to green in the control.

To slide the clip in time or move it through the project without changing its length, place the mouse pointer in the middle of the range control and drag it to the new location, or enter the value manually in the Global In value box.
**Process Mode**
Use this menu to select the Fields Processing mode used by Fusion when loading the image. The Has Fields checkbox control in the Frame Format preferences determines the default option, and the default height as well. Available options include:
- Full frames
- NTSC fields
- PAL/HD fields
- PAL/HD fields (reversed)
- NTSC fields (reversed).

The two reversed options load fields in the opposite order and thus result in the fields being spatially swapped both in time order and in vertical order as well.

**MediaID**
An ID assigned by DaVinci Resolve for that clip.

**Layer**
Used to identify the layer in a PSD file or compound clip. When a PSD file is brought in from the Media Pool, the drop-down menu allows you to select an individual layer for output instead of the entire PSD composite.

**Trim**
The Trim range control is used to trim frames from the start or end of a clip. Adjust the Trim In to remove frames from the start and adjust Trim Out to specify the last frame of the clip. The values used here are offsets. A value of 5 in Trim In would use the fifth frame in the sequence as the start, ignoring the first four frames. A value of 95 would stop loading frames after the 95th frame.

**Hold First Frame/Hold Last Frame:**
The Hold First Frame and Hold Last Frame controls hold the first or last frame of the clip for the specified amount of frames. Held frames are included in a loop if the footage is looped.

**Reverse**
Select this checkbox to reverse the footage so that the last frame is played first, and the first frame is played last.

**Loop**
Select this checkbox to loop the footage until the end of the project. Any lengthening of the clip using Hold First/Last Frame or shortening using Trim In/Out is included in the looped clip.

**Source Color Space**
Lets you choose a color space for the image data output by this MediaIn node.
- **Auto:** uses the Timeline color space, or whichever color space is assigned by Resolve Color Management (RCM) if it’s enabled.
- **Space:** Space lets you choose a specific setting from a Color Space drop-down menu, while a visual “horseshoe” graph lets you see a representation of the color space you’ve selected.

**Source Gamma Space**
Lets you choose a gamma setting for the image data output by this MediaIn node. Once the gamma curve type is set, you can choose to remove the curve to help achieve a linear workflow.
- **Auto:** Uses the Timeline gamma, or whichever gamma is assigned by Resolve Color Management (RCM) if it’s enabled.
– **Space:** Lets you choose a specific setting from a Gamma Space drop-down menu, while a visual graph lets you see a representation of the gamma setting you’ve selected.

– **Log:** Displays the Log Type drop-down menu where you can choose a specific log encoding profile. A visual graph shows a representation of the log setting chosen from the menu. Additional Lock RGB, Level, Soft Clip, Film Stock Gamma, Conversion Gamma, and Conversion table options are presented to finesse the gamma output.

– **Remove Curve:** The associated gamma curve is removed from, or a log-lin conversion is performed on, the material, effectively converting it to a linear output space.

– **Pre-Divide/Post-Multiply:** Lets you convert “straight” Alpha channels into premultiplied Alpha channels, when necessary.

---

Audio Tab

The Inspector for the MediaIn node contains an Audio tab, where you can choose to solo the audio from the clip or hear all the audio tracks in the Timeline.

If the audio is out of sync when playing back in Fusion, the Audio tab’s Sound Offset wheel allows you to slip the audio in subframe frame increments. The slipped audio is only modified in the Fusion page. All other pages retain the original audio placement.

Audio with Media Pool Clips

Audio from a clip brought in through the Media Pool is muted by default. Hearing the audio from a Media Pool clip is a two step process.

**To hear audio from a clip brought in through the Media Pool, do the following:**

1. Select the clip in the Node Editor.
2. In the Inspector, click the Audio tab and select the clip name from the Audio Track drop-down menu.
   
   If more than one MediaIn node exists in the comp, the audio last selected in the Inspector is heard. You can use the Speaker icon in the toolbar to switch between the MediaIn node audio files.
3. Right-click the Speaker icon in the toolbar, then choose the MediaIn for the clip you want to hear.

Purging the Audio Cache

The audio and its settings are cached for faster performance. If you change which audio tracks you want to play back in Fusion, or you use the Sound Offset wheel to slip the audio tracks, you need to purge the audio cache. Also, if you return to the Edit, Cut, or Fairlight page and modify the audio levels, you need to purge the audio cache.
To purge the audio cache after any change to the audio playback:

– Click the Purge Audio Cache button in the Inspector.

The audio will be updated when you next playback the composition.

## MediaOut Node [MO]

![The MediaOut node]

### MediaOut Node Introduction

**NOTE:** The MediaOut node is only available in DaVinci Resolve.

Every composition you create in DaVinci Resolve’s Fusion page must include a MediaOut node. The MediaOut node sends the final output back to your Timeline on DaVinci Resolve’s Edit or Cut page. In most cases, it replaces the Saver node used in Fusion Studio for exporting clips.

The composition output by the Fusion page’s MediaOut node is propagated via the Color page’s source inputs, with the sole exception that if you’ve performed transforms or added plug-ins to that clip in the Edit or Cut page, then the handoff from the Fusion page to the Color page is as follows:

![Fusion Effects ➔ Edit Page Plugs-ins ➔ Color Effects](image)

When using Resolve Color Management or ACES, each MediaOut node converts the output image back to the Timeline color space for handoff to the Color page.

**NOTE:** Additional MediaOut nodes can be added to the Node Editor from the Effects Library. Additional MediaOut nodes are used to pass mattes to the Color page.

### Inputs

The single input on the MediaOut node is where you connect the final composite image you want rendered back into the Edit page.

– **Input:** The orange input is a required input. It accepts any 2D image that you want rendered back into the Edit page.
Basic Node Setup

Multiple MediaOut nodes can exist in a single comp. The first MediaOut node always renders the image back to the Edit page Timeline. Additional MediaOut nodes can be used to pass mattes to the Color page.

MediaOut1 node rendering to the Edit page, and MediaOut2 sending mattes to the Color page

Saver Node [SV]

The Saver node

Saver Node Introduction

NOTE: The Saver node in DaVinci Resolve is only used for exporting EXR files.

The Saver node represents the final composition output from Fusion Studio. It is used to render out movie files or sequential images but can be inserted into a composition at any point to render out intermediate stages of a composition. A composition can contain any number of Saver nodes for rendering different branches of a comp as well as different formats.

The Saver node can also be used to add scratch track audio to your composition, which can be heard during interactive playback.

Inputs

The single input on the Saver node is for the final composition you want to render.

– **Image Input:** The orange input is used to connect the resulting image you want rendered.
Basic Node Setup

The Saver node is placed at the end of the composition. Multiple Savers can be placed in a comp to render different formats or to render different parts of a composition.

Inspector

File Tab

The Saver File tab is used to set the location and output format for the rendered file.

Filename

The Filename dialog is used to select the name and path of the rendered image output. Click on the Browse button to open a file browser and select a location for the output.

Sequence numbering is automatically added to the filename when rendering a sequential image file format. For example, if c\renders\image.exr is entered as the filename and 30 frames of output are rendered, the files are automatically numbered as image0000.tga, image0001.exr, image0003.exr... and so on. Four-digit padding is automatically used for numbers lower than 10000.

You can specify the number of digits to use for padding by explicitly entering the digits into the filename.

For example, image000000.exr would apply 6-digit padding to the numeric sequence, image.001.exr would use 3-digit padding, and image1.exr would use none.

Output Format

This menu is used to select the image format to be saved. Be aware that selecting a new format from this menu does not change the extension used in the filename to match. Modify the filename manually to match the expected extension for that format to avoid a mismatch between name and image format.
Save Frames
This control selects between two modes of rendering: Full Renders Only or High Quality Interactive.

- **Full Renders Only**: This is the common setting for most situations. Images are saved to disk when a final render is started using the Start Render button in the Time Ruler.

- **High Quality Interactive**: This render mode is designed for real-time rendering when painting and rotoscoping. Fusion saves each frame to disk as it is processed interactively. When used correctly, this feature can eliminate the need to perform a final render after rotoscoping.

**NOTE**: The High Quality Interactive setting can easily cause confusion when used in conjunction with a node tree that contains spline-animated parameters. If these splines are modified in such a way that frames already saved interactively are changed, the frames already on the disk do not automatically re-render. Either step through each frame again or perform a final render to make certain that the result is correct.

Frame Offset
This thumbwheel control can be used to set an explicit start frame for the number sequence applied to the rendered filenames. For example, if Global Start is set to 1 and frames 1-30 are rendered, files are normally numbered 0001-0030. If the Sequence Start Frame is set to 100, the rendered output would be numbered from 100-131.

Export Tab
Process Mode
Use this menu to select the Fields Processing mode used by Fusion when saving the images or movie file to disk. The Has Fields checkbox control in the Frame Format preferences determines the default option, and the default height as well. Available options include:

- Full frames
- NTSC fields
- PAL/HD fields
- PAL/HD fields (reversed)
- NTSC fields (reversed).

The two reversed options save fields in the opposite order and thus result in the fields being spatially swapped both in time order and in vertical order as well.
**Export Mode**
This menu is used to render out the file normally or apply a SMPTE standard 3:2 pulldown to the footage, converting the footage from 24 fps to 30 fps.

**Clipping Mode**
This menu, sometimes considered source image clipping, defines how the edges of the image should be treated.

- **Frame:** The default Frame setting clips to the parts of the image visible within its visible dimensions. It breaks any infinite-workspace behavior. If the upstream DoD is smaller than the frame, the remaining area in the frame is treated as black/transparent.

- **None:** This setting does not perform any source image clipping at all. This means that any data that would normally be needed outside the upstream DoD is treated as black/transparent. Be aware that this might create humongous images that can consume a considerate amount of disk space. So you should use this option only if really needed.


**Save Alpha to Color**
When enabled, this control causes the Alpha channel to be saved into the color channels as a grayscale image. This completely overwrites any existing color information.

**Color Space Type**
This menu is used to set the Color Space of the output file so you could, for example, color space convert images from linear to Rec709, etc., thereby delivering linear EXRs, 709 Quicktimes, etc. from a single source. The images are not being converted in the Comp, only in the images saved to disk are converted.

- **Auto:** Passes along any metadata that might be in the rendered image.

- **Space:** Allows the user to set the color space based on the output format.

**Curve Type**
This menu is used to select a Gamma curve of the rendered file. Once the gamma curve type is set, you can choose to apply the curve for output.

- **Auto:** Passes along any metadata that might be in the incoming image.

- **Space:** Allows the user to set the gamma curve based on the selected file format.

- **Log:** Displays the Log/Lin settings, similar to the Cineon Log node. For more detail on the Log settings, see Chapter 38, “Film Nodes” in the Fusion Reference Manual or Chapter 99 in the DaVinci Resolve Reference Manual.

**Apply Curve**
Depending on the selected Curve Type or on the Gamma Space found in Auto mode, the associated Gamma Curve is applied, effectively converting from a linear working space.
Audio Tab

![Saver Audio tab]

**NOTE:** This tab is only available in Fusion Studio's Saver node.

The audio functionality is included in Fusion Studio for scratch track (aligning effects to audio and clip timing) purposes only. Final renders should almost always be performed without audio. The smallest possible audio files should be used, as Fusion loads the entire audio file into memory for efficient display of the waveform in the Timeline. The audio track is included in the saved image if a Quicktime file format is selected. Fusion currently supports playback of WAV audio.

**Source Filename**

You can enter the file path and name of the audio clip you want to use in the Source Filename field. You can also click the Browse button to open a file browser window and locate the audio scratch track. Select the WAV file of choice, and then in the keyframes panel expand the Saver bar to view the audio waveform. Drag the pointer over the audio wave in the Timeline layout to hear the track.

**Sound Offset**

Drag the control left or right to slide the Timeline position of the audio clip, relative to other nodes in the Node Editor.

Legal Tab

The Legal tab includes settings for creating “broadcast safe” saturation and video range files for output.

![Saver Legal tab]

**Video Type**

Use this menu to select the standard to be used for broadcast legal color correction. NTSC, NHK, or PAL/SECAM can be chosen.

**Action**

Use this menu to choose how Fusion treats illegal colors in the image.

- **Adjust to Legal:** This causes the images to be saved with legal colors relevant to the Video Type selected.
– **Indicate as Black:** This causes the illegal colors to be displayed as black in the views.
– **Indicate as White:** This causes the illegal colors to be displayed as white in the views.
– **No Changes:** This causes the images to be saved unaffected.

**Adjust Based On**

This menu is used to choose whether Fusion makes legal the image to 75% or 100% amplitude. Very few broadcast markets permit 100% amplitude, but for the most part this should be left to 75%.

**Soft Clip**

The Soft Clip control is used to draw values that are out of range back into the image. This is done by smoothing the conversion curve at the top and bottom of the curve, allowing more values to be represented.

**Format Tab**

The Format tab contains information, options, and settings specific to the image format being saved. The controls for an EXR sequence is entirely different from the ones displayed when a MOV file is saved.

EXR is displayed above for reference.

When the Saver node is set to DPX, it’s important to understand the reason for the Bypass Conversion > Data is Linear option. When saving log data into a DPX, and not using the Saver’s node’s own lin-log conversion (that is, Bypass Conversion is checked), the Data Is Linear option should be off. This indicates whether the reason for checking Bypass Conversion is because the data is linear, or whether it’s already log.

If Data Is Linear is enabled, then the DPX is marked in its header as containing linear data. In turn, that means that when the DPX is loaded back into Fusion, or into other apps that evaluate the header, those apps think the data is linear and do not perform any log-lin conversion.
Common Controls

Settings Tab
The Settings tab controls are common to both Loader and Saver nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.

Clipping Mode
This menu, sometimes considered source image clipping, defines how the edges of the image should be treated.

- **Frame:** The default Frame setting clips to the parts of the image visible within its visible dimensions. It breaks any infinite-workspace behavior. If the upstream DoD is smaller than the frame, the remaining areas in the frame are treated as black/transparent.

- **None:** This setting does not perform any source image clipping at all. This means that any data that would normally be needed outside the upstream DoD is treated as black/transparent. Be aware that this might create humongous images which can consume a considerable amount of disk space. So you should use this option only if really needed.


Save Alpha to Color
When enabled, this control causes the Alpha channel to be saved into the color channels as a grayscale image. This completely overwrites any existing color information.

Color Space Type
This menu is used to set the Color Space of the output file so you could, for example, color space convert images from linear to Rec709, etc., thereby delivering linear EXRs, 709 Quicktimes, etc. from a single source. The images are not being converted in the Comp, only in the images saved to disk are converted.

- **Auto:** Passes along any metadata that might be in the rendered image.

- **Space:** Allows the user to set the color space based on the output format.

Curve Type
This menu is used to select a Gamma curve of the rendered file. Once the gamma curve type is set, you can choose to apply the curve for output.

- **Auto:** Passes along any metadata that might be in the incoming image.

- **Space:** Allows the user to set the gamma curve based on the selected file format.

- **Log:** Displays the Log/Lin settings, similar to the Cineon Log node. For more detail on the Log settings, see Chapter 38, “Film Nodes” in the Fusion Reference Manual or Chapter 99 in the DaVinci Resolve Reference Manual.

Apply Curve
Depending on the selected Curve Type or on the Gamma Space found in Auto mode, the associated Gamma Curve is applied, effectively converting from a linear working space.
The Common Controls

I/O nodes share a number of identical controls in the Inspector. This section describes controls that are common among I/O nodes.

Inspector

![Common Saver settings inspector](image)

Settings Tab

The Settings tab in the Inspector can be found on the Loader, Saver, MediaIn, and MediaOut nodes. The controls are consistent and work the same way for each tool, although some parameters are only available on individual nodes but are covered here.

Blend

The Blend control is used to blend between the tool’s original image input and the tool’s final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming image. Normally, this causes the tool to skip processing entirely, copying the input straight to the output.

Process When Blend Is 0.0

The tool is processed even when the input value is zero. This can be useful if processing of this node is scripted to trigger another task, but the value of the node is set to 0.0.

Red/Green/Blue/Alpha Channel Selector

These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.

For example, if the red button on a Blur tool is deselected, the blur is first applied to the image, and then the red channel from the original input is copied back over the red channel of the result.
There are some exceptions, such as tools for which deselecting these channels causes the tool to skip processing that channel entirely. Tools that do this generally possess a set of identical RGBA buttons on the Controls tab in the tool. In this case, the buttons in the Settings and the Controls tabs are identical.

**Apply Mask Inverted**
Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

**Multiply by Mask**
Selecting this option causes the RGB values of the masked image to be multiplied by the mask channel's values. This causes all pixels of the image not included in the mask (i.e., set to 0) to become black/transparent.

**Use Object/Use Material (Checkboxes)**
Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports Object and Material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels are used, if present. The specific Material ID or Object ID affected is chosen using the next set of controls.

**Correct Edges**
This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information on Coverage and Background Color channels, see Chapter 18, “Understanding Image Channels” in the Fusion Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.

**Object ID/Material ID (Sliders)**
Use these sliders to select which ID is used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker: to grab IDs from the image displayed in the view. The image or sequence must have been rendered from a 3D software package with those channels included.

**Hide Incoming Connections**
Enabling this checkbox can hide connection lines from incoming nodes, making a node tree appear cleaner and easier to read. When enabled, empty fields for each input on a node are displayed in the Inspector. Dragging a connected node from the node tree into the field hides that incoming connection line as long as the node is not selected in the node tree. When the node is selected in the node tree, the line reappears.

**Comments**
The Comments field is used to add notes to a tool. Click in the empty field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

**Scripts**
Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
Chapter 106

LUT Nodes

This chapter details the LUT nodes available in Fusion.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn/MediaOut nodes in DaVinci Resolve are interchangeable with Loader/Saver nodes in Fusion Studio, unless otherwise noted.

Contents

File LUT [FLU] 2037
LUT Cube Analyzer [LCA] 2039
LUT Cube Apply [LCP] 2040
LUT Cube Creator [LCC] 2041
The Common Controls 2043
File LUT [FLU]

The File LUT node applies a Lookup table (LUT) to the image: either a simple 1D LUT or a supported 3D LUT. Unlike the Color Curves node, it does not use a spline-based LUT. Instead, it loads the LUT from a file stored on your computer or server.

This approach has two advantages. The first is that the only part of the LUT stored in the composition is the path to the file. Since LUT files can be large, this can dramatically reduce the file size of a composition when several LUTs are present. The second advantage is that it becomes possible to adjust all File LUT nodes using the same file at the same time, just by changing the contents of the LUT. This can be useful when the same LUT-based color correction is applied in many different compositions.

Inputs

The File LUT node includes two inputs: one for the main image and the other for an effect mask to limit the area where the LUT is applied.

- **Input**: This orange input is the only required connection. It accepts a 2D image output that gets the LUT applied.
- **Effect Mask**: The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the applied LUT to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

The File LUT node can be placed after a MediaIn node in DaVinci Resolve or a Loader node in Fusion Studio. Sometimes this setup is used to convert the camera-original image to linear color space for compositing. Other times, as in the example below, the File LUT is applied at the end as a grading LUT to apply a look from the colorist.
Inspector

Controls Tab
The Controls tab includes options for loading a LUT and making adjustments to the gain, color space, and Alpha channel, if one exists.

LUT File
This field is used to enter the path to the LUT file. Clicking the Browse button opens a file browser window to locate the LUT file instead of entering it manually into the LUT File field. Currently, this node supports LUTs exported from Fusion in .LUT and .ALUT formats, DaVinci Resolve’s .CUBE format, and several 3D LUT formats. The node fails with an error message on the Console if it is unable to find or load the specified file.

Pre-Gain:
This slider is a gain adjustment before the LUT being applied. This can be useful for pulling in highlights before the LUT clips them.

Post-Gain
This slider is a gain adjustment after the LUT is applied.

Color Space
This menu is used to change the color space the LUT is applied in. The default is to apply the curves described in the LUT to the RGB color space, but options for YUV, HLS, HSV, and others are also available.

Pre-Divide/Post-Multiply
Selecting the Pre-Divide/Post-Multiply checkbox causes the image pixel values to be divided by the Alpha values before applying the LUT, and then re-multiplied by the Alpha value after the correction. This helps to prevent the creation of illegally additive images, particularly around the edges of a blue/green key or when working with 3D-rendered objects.

Settings Tab
The Settings tab in the Inspector is also duplicated in other LUT nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
LUT Cube Analyzer [LCA]

The LUT Cube Analyzer node

LUT Cube Analyzer Node Introduction

The LUT Cube Analyzer takes an image originated by the LUT Cube Creator as an input and allows the user to create a 3D LUT file in ALUT3, ITX, or 3DL format.

Feeding the original LUT Cube Creator image into the node results in an unaltered, or 1:1, LUT file, and nothing is displayed in the viewer.

You can, however, modify, grade, and color correct the original cube image with as many nodes as you like and feed the result into the LUT Cube Analyzer. This creates a LUT that exactly resembles your color pipeline.

Inputs

The LUT Cube Analyzer includes a single orange input.

- **Input**: The orange input is used to take the output of any node modifying an image that originated with the LUT Cube Creator.

Basic Node Setup

The example below shows a node tree starting with a LUT Cube Creator node and going through two color adjustments. The adjusted image is then connected to a LUT Cube Analyzer, which generates the LUT file.

Generating a LUT starts with the LUT Cube Creator and ends with a LUT Cube Analyzer.

Inspector

LUT Cube Analyzer controls
Controls Tab
The Controls tab for the LUT Cube Analyzer node is used to select the desired LUT output format, specify a filename, and write the 3D LUT to disk.

Type
Select the desired output format of the 3D LUT.

Filename
Enter the path where you want the file saved and enter the name of the LUT file. Alternatively, you can click the Browse button to open a file browser to select the location and filename.

Write File
Press this button to generate the 3D LUT file based on the settings above.

Settings Tab
The Settings tab in the Inspector is also duplicated in other LUT nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

LUT Cube Apply [LCP]

LUT Cube Apply Node Introduction
The LUT Cube Apply node takes an image created by the LUT Cube Creator as the foreground input and applies that LUT to the image connected to the background input.

Feeding the original image into the node would result in an unaltered, or 1:1, output.

You can, however, modify, grade, and color correct the original cube image with as many nodes as you like and feed the result into the LUT Cube Apply. Or, take a LUT image that has been graded beforehand to apply the LUT without having to write an actual 3D LUT using the LUT Cube Analyzer.

Inputs
The LUT Cube Apply has three inputs: a green input where the output of the LUT Cube Creator is connected, an orange input for the image to have the LUT applied, and a blue effect mask input

- **Input:** This orange input accepts a 2D image that gets the LUT applied.
- **Reference Image:** The green input is used to connect the output of the LUT Cube Creator or a node that is modifying the image originating in the LUT Cube Creator.
- **Effect Mask:** The optional effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the LUT Cube Apply to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.
Basic Node Setup

The example below shows a node tree starting with a LUT Cube Creator node and going through two color adjustments. The adjusted image is then connected to the green Reference input of the LUT Cube Apply. The image you want to apply the LUT to is connected to the orange Input.

The LUT generated by the LUT Cube Creator is applied to an image using the LUT Cube Apply node.

Inspector

There are no controls for the LUT Cube Apply node. The LUT connected to the green foreground input is applied to the image connected to the orange background input without having to write an actual 3D LUT using the LUT Cube Analyzer.

Settings Tab

The Settings tab in the Inspector is also duplicated in other LUT nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

LUT Cube Creator [LCC]

LUT Cube Creator Node Introduction

The LUT Cube Creator generates an image for further use with the LUT Cube Analyzer or LUT Cube Apply nodes. The output can be graded, color corrected, or modified with any tool inside and outside of Fusion. If working outside Fusion, make sure to keep the image in 32-bit floating point to preserve color accuracy.

Feeding the original LUT Cube Creator image into the LUT Cube Analyzer node results in an unaltered, or 1:1, LUT file, and nothing is displayed in the viewer.

Inputs

There are no inputs on the LUT Cube Creator. The purpose of the node is to generate an image that can be used to create a LUT.
Basic Node Setup

The example below shows a node tree starting with a LUT Cube Creator node and going through two color adjustments. The adjusted image is then connected into a LUT Cube Analyzer that generates the LUT file.

Generating a LUT starts with the LUT Cube Creator and ends with a LUT Cube Analyzer.

Inspector

LUT Cube Creator controls

Controls Tab

The Controls tab creates a test pattern of sorts used to create a 3D LUT. The controls here determine the complexity of the pattern used to create a LUT using the LUT Cube Analyzer.

Type:

The Type menu is used to create a pattern of color cubes.

- **Horizontal**: Creates a long, horizontal strip representing a color cube.
- **Vertical**: Creates a long, vertical strip representing a color cube.
- **Rect**: Creates a rectangular image, as depicted below, representing a color cube.

A Cube image created with the Rect type

The resulting color cube
Size

Determines the resolution of the color cube.

Typical Size settings for color cubes are 33 (33 x 33 x 33) or 65 (65 x 65 x 65). These numbers are the samples on each side of the cube. A 33 x 33 x 33 cube has around 35,937 color samples.

**NOTE:** Higher resolutions yield more accurate results but are also more memory and computationally expensive.

Settings Tab

The Settings tab in the Inspector is also duplicated in other LUT nodes. These common controls are described in the following “The Common Controls” section.

The Common Controls

LUT nodes share a number of identical controls in the Inspector. This section describes controls that are common among LUT nodes.

Inspector

Settings Tab

The Settings tab in the Inspector can be found on every tool in the LUT category. The controls are consistent and work the same way for each tool, although some tools do include one or two individual options, which are also covered here.
Use GPU
The Use GPU menu has three settings. Setting the menu to Disable turns off hardware-accelerated rendering using the graphics card in your computer. Enabled uses the hardware. Auto uses a capable GPU if one is available and falls back to software rendering when a capable GPU is not available.

Hide Incoming Connections
Enabling this checkbox can hide connection lines from incoming nodes, making a node tree appear cleaner and easier to read. When enabled, empty fields for each input on a node are displayed in the Inspector. Dragging a connected node from the node tree into the field hides that incoming connection line as long as the node is not selected in the node tree. When the node is selected in the node tree, the line reappears.

Comments
The Comments field is used to add notes to a tool. Click in the empty field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

Scripts
Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
Chapter 107

Mask Nodes

This chapter details the Mask nodes available in Fusion.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

- Bitmap Mask [BMP] 2046
- B-Spline Mask [BSP] 2050
- Ellipse Mask [ELP] 2054
- Mask Paint [PNM] 2057
- Polygon Mask [PLY] 2060
- Ranges Mask [RNG] 2065
- Rectangle Mask [REC] 2070
- Triangle Mask [TRI] 2073
- Wand Mask [WND] 2076
- The Common Controls 2079
Bitmap Mask Node Introduction

The Bitmap mask node allows images from the node tree to act as masks for nodes and effects. Bitmap masks can be based on values from any of the color, Alpha, hue, saturation, luminance, and auxiliary coverage channels of the image. Nodes can also be masked based on the Object ID or Material ID of a 3D-rendered image (provided those channels were included when the file was rendered).

The Bitmap mask node is not required for effect masks. For effects masks, the Common Settings tab for the masked node displays controls to select which channel of the mask image is used to create the mask.

However, Bitmap mask nodes may still be required to connect to other mask inputs on some nodes, such as Garbage Mattes and Pre-Masks. Also, using a Bitmap mask node between the mask source and the target node provides additional options that would not be available when connecting directly, such as combining masks, blurring the mask, or clipping its threshold.

Inputs

The Bitmap mask node includes two inputs in the Node Editor.

- **Input**: The orange input accepts a 2D image from which the mask will be created.
- **Effect Mask**: The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input combines the masks. How masks are combined is handled in the Paint mode menu in the Inspector.

Basic Node Setup

The Bitmap mask node is not required for connecting an image into the effect mask input, but it does provide options that are otherwise unavailable. It allows for selecting channels other than RGBA for the mask, as well as softness and clipping. In the node tree below, the two Bitmap masks are combined using a Paint menu located in the second Bitmap mask node, which allows you to add, subtract, multiply, and perform other operations on the combined mask.
Inspector

Controls Tab
The Controls tab is used to refine how the image connected to the orange input converts into the Bitmap mask.

Show View Controls
The Show View Controls checkbox is used to enable/disable the display of the mask’s onscreen controls in the viewer. Onscreen controls, including center position, polylines, angles, and others, do not appear when this checkbox is disabled, even when the node is selected.

Level
The Level control sets the transparency level of the pixels in the mask channel. When the value is 1.0, the mask is completely opaque (unless it has a soft edge). Lower values cause the mask to be partially transparent. The result is identical to lowering the Blend control of an effect.

NOTE: Lowering the level of a mask lowers the values of all pixels covered by the mask in the mask channel. For example, if a Circle mask is placed over a Rectangle mask, lowering the level of the Circle mask lowers the values of all the pixels in the mask channel, even though the Rectangle mask beneath it is still opaque.

Filter
This control selects the filtering algorithm used when applying Soft Edge to the mask.

- **Box**: This is the fastest method but at reduced quality. Box is best suited for minimal amounts of blur.

- **Bartlett**: Otherwise known as a Pyramid filter, Bartlett makes a good compromise between speed and quality.

- **Multi-box**: When selecting this filter, the Num Passes slider appears and lets you control the quality. At 1 and 2 passes, results are identical to Box and Bartlett, respectively. At 4 passes and above, results are usually as good as Gaussian, in less time and with no edge “ringing.”
– **Gaussian:** The Gaussian filter uses a true Gaussian approximation and gives excellent results, but it is a little slower than the other filters. In some cases, it can produce an extremely slight edge “ringing” on floating-point pixels.

**Soft Edge**

Use the Soft Edge slider to blur (feather) the mask, using the selected filter. Higher values cause the edge to fade off well beyond the boundaries of the mask. A value of 0.0 creates a crisp, well-defined edge.

**Paint Mode**

Connecting a mask to the effect mask input displays the Paint mode menu. The Paint mode is used to determine how the incoming mask for the effect mask input and the mask created in the node are combined.

– **Merge:** Merge is the default for all masks. The new mask is merged with the input mask.
– **Add:** The mask’s values add to the input mask’s values.
– **Subtract:** In the intersecting areas, the new mask values subtract from the input mask’s values.
– **Minimum:** Comparing the input mask’s values and the new mask, this displays the lowest (minimum) value.
– **Maximum:** Comparing the input mask’s values and the new mask, this displays the highest (maximum) value.
– **Average:** This calculates the average (half the sum) of the new mask and the input mask.
– **Multiply:** This multiplies the values of the input mask by the new mask’s values.
– **Replace:** The new mask completely replaces the input mask wherever they intersect. Areas that are zero (completely black) in the new mask do not affect the input mask.
– **Invert:** Areas of the input mask that are covered by the new mask are inverted; white becomes black and vice versa. Gray areas in the new mask are partially inverted.
– **Copy:** This mode completely discards the input mask and uses the new mask for all values.
– **Ignore:** This mode completely discards the new mask and uses the input mask for all values.

**Invert**

Selecting this checkbox inverts the entire mask. Unlike the Invert Paint mode, this checkbox affects all pixels, regardless of whether the new mask covers them.

**Fit Input**

This menu is used to select how the image source is treated if it does not fit the dimensions of the generated mask.

In the example below, a 720 x 576 image source (yellow) is used to generate a 1920 x 1080 mask (gray).

– **Crop:** If the image source is smaller than the generated mask, it will be placed according to the X/Y controls, masking off only a portion of the mask. If the image source is larger than the generated mask, it will be placed according to the X/Y controls and cropped off at the borders of the mask.
– **Stretch**: The image source will be stretched in X and Y to accommodate the full dimensions of the generated mask. This might lead to visible distortions of the image source.

– **Inside**: The image source will be scaled uniformly until one of its dimensions (X or Y) fits the inside dimensions of the mask. Depending on the relative dimensions of the image source and mask background, either the image source’s width or height may be cropped to fit the respective dimensions of the mask.

– **Width**: The image source will be scaled uniformly until its width (X) fits the width of the mask. Depending on the relative dimensions of the image source and mask, the image source’s Y dimension might not fit the mask’s Y dimension, resulting in either cropping of the image source in Y or the image source not covering the mask’s height entirely.

– **Height**: The image source will be scaled uniformly until its height (Y) fits the height of the mask. Depending on the relative dimensions of the image source and mask, the image source’s X-dimension might not fit the mask’s X-dimension, resulting in either cropping of the image source in X or the image source not covering the mask’s width entirely.
– **Outside:** The image source will be scaled uniformly until one of its dimensions (X or Y) fits the outside dimensions of the mask. Depending on the relative dimensions of the image source and mask, either the image source’s width or height may be cropped or not fit the respective dimension of the mask.

**Center X and Y**
These controls adjust the position of the Bitmap mask.

**Channel**
The Channel menu determines the Channel of the input image used to create the mask. Choices include the red, green, blue, and alpha channels, the hue, luminance, or saturation values, or the auxiliary coverage channel of the input image (if one is provided).

**Threshold Low/High**
The Threshold range control can be used to clip the bitmap image. Increasing the low range control will clip pixels below the specified value to black (0.0). Decreasing the high range control will force pixels higher than the specified value to white (1.0).

**Use Object/Use Material**
This control has no effect unless the input image contains a Material or Object ID channel. When toggled on, the Object ID and Material ID are used to create a mask based on the selected object or material. When toggled off, the regular color channels will generate the mask.

**Common Controls**

**Image and Settings Tabs**
The Image and Settings tabs in the Inspector are also duplicated in other Mask nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

---

**B-Spline Mask [BSP]**

A B-Spline mask is identical to a Polygon mask in all respects except one. Where Polygon masks use Bézier splines, this mask node uses B-Splines. Where Bézier splines employ a central point and two handles to manage the smoothing of the spline segment, a B-Spline requires only a single point. This means that a B-Spline shape requires far fewer control points to create a nicely smoothed shape.

When first added to a node, the B-Spline mask consists of only Center control, which is visible onscreen. Points are added to the B-Spline by clicking in the viewer. Each new point is connected to
the last one created, but instead of the spline going directly through each control point, B-Spline control points only influence the spline shape. The control point pulls the spline in its direction to create a smooth curve.

Like the Polygon mask tool, the B-Spline mask auto-animates. Adding this node to the Node Editor adds a keyframe to the current frame. Moving to a new frame and changing the shape creates a new keyframe and interpolate between the two defined shapes.

**Inputs**

The B-Spline mask node includes a single effect mask input.

- **Effect Mask**: The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input combines the masks. How masks are combined is handled in the Paint mode menu in the Inspector.

**Basic Node Setup**

The B-Spline node can be used to generate a single smooth spline shape or combined with other masks for more complex shapes. In the node tree below, the B-Spline mask is used to generate a smooth, curved shape as a garbage matte on the Delta Keyer.

![Node Tree Diagram](image)

*A B-Spline node generates a smooth, curved shape as a garbage matte*

**Inspector**

![Inspector Panel](image)

*B-Spline Mask controls*
Controls Tab

The Controls tab is used to refine how the B-Spline appears after drawing it in the viewer.

Show View Controls

The Show View Controls checkbox is used to enable/disable the display of the mask’s onscreen controls in the viewer. Onscreen controls, including center position, polylines, angles, and others, do not appear when this checkbox is disabled, even when the node is selected.

Level

The Level control sets the transparency level of the pixels in the mask channel. When the value is 1.0, the mask is completely opaque (unless it has a soft edge). Lower values cause the mask to be partially transparent. The result is identical to lowering the blend control of an effect.

NOTE: Lowering the level of a mask lowers the values of all pixels covered by the mask in the mask channel. For example, if a Circle mask is placed over a Rectangle mask, lowering the level of the Circle mask lowers the values of all of the pixels in the mask channel, even though the Rectangle mask beneath it is still opaque.

Filter

This control selects the filtering algorithm used when applying Soft Edge to the mask.

– **Box**: This is the fastest method but at reduced quality. Box is best suited for minimal amounts of blur.

– **Bartlett**: Otherwise known as a Pyramid filter, Bartlett makes a good compromise between speed and quality.

– **Multi-box**: When selecting this filter, the Num Passes slider appears and lets you control the quality. At 1 and 2 passes, results are identical to Box and Bartlett, respectively. At 4 passes and above, results are usually as good as Gaussian, in less time and with no edge “ringing.”

– **Gaussian**: The Gaussian filter uses a true Gaussian approximation and gives excellent results, but it is a little slower than the other filters. In some cases, it can produce an extremely slight edge “ringing” on floating-point pixels.

Soft Edge

Use the Soft Edge slider to blur (feather) the mask, using the selected filter. Higher values cause the edge to fade off well beyond the boundaries of the mask. A value of 0.0 creates a crisp, well-defined edge.

Border Width

The Border Width control adjusts the thickness of the mask’s edge. When the solid checkbox is toggled on, the border thickens or narrows the mask. When the mask is not solid, the mask shape draws as an outline, and the width uses the Border Width setting.

Paint Mode

Connecting a mask to the effect mask input displays the Paint mode menu. The Paint mode is used to determine how the incoming mask for the effect mask input and the mask created in the node are combined.

– **Merge**: Merge is the default for all masks. The new mask is merged with the input mask.

– **Add**: The mask’s values add to the input mask’s values.

– **Subtract**: In the intersecting areas, the new mask values subtract from the input mask’s values.
– **Minimum:** Comparing the input mask’s values and the new mask, this displays the lowest (minimum) value.

– **Maximum:** Comparing the input mask’s values and the new mask, this displays the highest (maximum) value.

– **Average:** This calculates the average (half the sum) of the new mask and the input mask.

– **Multiply:** This multiplies the values of the input mask by the new mask’s values.

– **Replace:** The new mask completely replaces the input mask wherever they intersect. Areas that are zero (completely black) in the new mask do not affect the input mask.

– **Invert:** Areas of the input mask that are covered by the new mask are inverted; white becomes black and vice versa. Gray areas in the new mask are partially inverted.

– **Copy:** This mode completely discards the input mask and uses the new mask for all values.

– **Ignore:** This mode completely discards the new mask and uses the input mask for all values.

**Invert**
Selecting this checkbox inverts the entire mask. Unlike the Invert Paint mode, the checkbox affects all pixels, regardless of whether the new mask covers them or not.

**Solid**
When the Solid checkbox is enabled, the mask is filled to be transparent (white) unless inverted. When disabled, the spline is drawn as just an outline whose thickness is determined by the Border Width slider.

**Center X and Y**
These controls adjust the position of the B-Spline mask.

**Size**
Use the Size control to adjust the scale of the B-Spline effect mask, without affecting the relative behavior of the points that compose the mask or setting a keyframe in the mask animation.

**X, Y, and Z Rotation**
Use these three controls to adjust the rotation angle of the mask along any axis.

**Fill Method**
The Fill Method menu offers two different techniques for dealing with overlapping regions of a polyline. If overlapping segments in a mask are causing undesirable holes to appear, try switching the setting of this control from Alternate to Non Zero Winding.

**Right-Click Here for Shape Animation**
By default, all B-Spline masks are animated when they are created. The initial keyframe is set to the current time, and any changes to the shape at different times will create new keys.

Right-clicking on this label will display a contextual menu that offers options for removing or re-adding animation to the mask, or publishing and connecting the masks.

**Adding Points**
Adding Points to a B-Spline effect mask is relatively simple. Immediately after adding the node to the Node Editor, there are no points, but the tool will be in Click Append mode. Click once in the viewer wherever a point is required for the mask. Continue clicking to draw the shape of the mask.

When the shape is complete, click on the initial point again to close the mask.

When the shape is closed, the mode of the polyline changes to Insert and Modify. This allows you to add and adjust additional points on the mask by clicking the spline segments. To lock down the mask’s...
shape and prevent accidental changes, switch the Polyline mode to Done using the Polyline toolbar or contextual menu.

**Adjusting Tension on a B-Spline**

The tension of the control point determines the smoothness of a B-Spline. To adjust the tension of a B-Spline's control points, select the point in the viewer, hold down the W key and drag the mouse pointer to the left and right to increase or decrease the tension of the curve through that point.

![Adjusting Tension on a B-Spline](image)

**B-Spline Toolbar**

When a B-Spline mask is selected in the Node Editor, a toolbar appears above the viewer with buttons for easy access to the modes. Position the pointer over any button in the toolbar to display a tooltip that describes that button's function.

![B-Spline Mask Polygon toolbar](image)

You can change the way the toolbar is displayed by right-clicking on the toolbar and selecting from the options displayed in the toolbar's contextual menu.

The functions of the buttons in this toolbar are explained in depth in the Polylines section.

**Common Controls**

**Image and Settings Tabs**

The Image and Settings tabs in the Inspector are also duplicated in other mask nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

**Ellipse Mask [ELP]**

![The Ellipse node](image)
**Ellipse Mask Node Introduction**

The Ellipse mask is most useful for masking round objects. It is a circle by default, but independent control is offered over the width, height, and angle, providing for a wide variety of ellipsoidal shapes.

**Inputs**

The Ellipse mask node includes a single effect mask input.

- **Effect Mask:** The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input combines the masks. How masks are combined is handled in the Paint mode menu in the Inspector.

**Basic Node Setup**

The Ellipse mask node is useful for generating circular masks. Below, the Ellipse mask is used to generate a circular colored shape by cutting a circular shape from a background node.

**Inspector**

The Controls tab is used to refine how the ellipse appears after drawing it in the viewer.

**Show View Controls**

The Show View Controls checkbox is used to enable/disable the display of the mask’s onscreen controls in the viewer. Onscreen controls, including center position, polylines, angles, and others, do not appear when this checkbox is disabled, even when the node is selected.
**Level**

The Level control sets the transparency level of the pixels in the mask channel. When the value is 1.0, the mask is completely opaque (unless it has a soft edge). Lower values cause the mask to be partially transparent. The result is identical to lowering the blend control of an effect.

**NOTE:** Lowering the level of a mask lowers the values of all pixels covered by the mask in the mask channel. For example, if a Circle mask is placed over a Rectangle mask, lowering the level of the Circle mask lowers the values of all the pixels in the mask channel, even though the Rectangle mask beneath it is still opaque.

**Filter**

This control selects the filtering algorithm used when applying Soft Edge to the mask.

- **Box:** This is the fastest method but at reduced quality. Box is best suited for minimal amounts of blur.
- **Bartlett:** Otherwise known as a Pyramid filter, Bartlett makes a good compromise between speed and quality.
- **Multi-box:** When selecting this filter, the Num Passes slider appears and lets you control the quality. At 1 and 2 passes, results are identical to Box and Bartlett, respectively. At 4 passes and above, results are usually as good as Gaussian, in less time and with no edge “ringing.”
- **Gaussian:** The Gaussian filter uses a true Gaussian approximation and gives excellent results, but it is a little slower than the other filters. In some cases, it can produce an extremely slight edge “ringing” on floating-point pixels.

**Soft Edge**

Use the Soft Edge slider to blur (feather) the mask, using the selected filter. Higher values cause the edge to fade off well beyond the boundaries of the mask. A value of 0.0 creates a crisp, well-defined edge.

**Border Width**

The Border Width control adjusts the thickness of the mask’s edge. When the solid checkbox is toggled on, the border thickens or narrows the mask. When the mask is not solid, the mask shape draws as an outline, and the width uses the Border Width setting.

**Paint Mode**

Connecting a mask to the effect mask input displays the Paint mode menu. The Paint mode is used to determine how the incoming mask for the effect mask input and the mask created in the node are combined.

- **Merge:** Merge is the default for all masks. The new mask is merged with the input mask.
- **Add:** The mask’s values add to the input mask’s values.
- **Subtract:** In the intersecting areas, the new mask values subtract from the input mask’s values.
- **Minimum:** Comparing the input mask’s values and the new mask, this displays the lowest (minimum) value.
- **Maximum:** Comparing the input mask’s values and the new mask, this displays the highest (maximum) value.
- **Average:** This calculates the average (half the sum) of the new mask and the input mask.
- **Multiply:** This multiplies the values of the input mask by the new mask’s values.
– **Replace**: The new mask completely replaces the input mask wherever they intersect. Areas that are zero (completely black) in the new mask do not affect the input mask.

– **Invert**: Areas of the input mask that are covered by the new mask are inverted; white becomes black and vice versa. Gray areas in the new mask are partially inverted.

– **Copy**: This mode completely discards the input mask and uses the new mask for all values.

– **Ignore**: This mode completely discards the new mask and uses the input mask for all values.

### Invert

Selecting this checkbox inverts the entire mask. Unlike the Invert Paint mode, the checkbox affects all pixels, regardless of whether the new mask covers them or not.

### Solid

When the Solid checkbox is enabled, the mask is filled to be transparent (white) unless inverted. When disabled, the spline is drawn as just an outline whose thickness is determined by the Border Width slider.

### Center X and Y

These controls adjust the position of the Ellipse mask.

### Width

This control allows independent control of the ellipse mask’s Width. In addition to the slider in the mask’s controls, interactively drag the width (left or right edge) of the mask on the viewer using the pointer. Any changes will be reflected in this control.

### Height

Height allows independent control of the ellipse mask’s height. In addition to the slider in the mask’s controls, interactively drag the height (top or bottom edge) of the mask on the view using the pointer. Any changes will be reflected in this control.

To change the mask’s size without affecting the aspect ratio, drag the onscreen control between the edges (diagonal). This will modify both the width and height proportionately.

### Angle

Change the rotational angle of the mask by moving the Angle control left or right. Values can be entered into the number fields provided. Alternately, use the onscreen controls by dragging the little circle at the end of the dashed angle line to interactively adjust the rotation of the ellipse.

### Common Controls

#### Image and Settings Tabs

The Image and Settings tabs in the Inspector are also duplicated in other mask nodes. These common controls are described in detail at the end of this chapter in "The Common Controls” section.
Mask Paint Node Introduction

The Mask Paint node allows direct painting of mask images, using the pointer as if it was a paintbrush. In addition to regular paint strokes, it is possible to apply basic primitive shapes and polyline style strokes.

Each stroke can have a duration that lasts for the entire project, a single frame, or an arbitrary number of fields. The strokes can have independent durations in the Keyframes Editor for easy manipulation of time. Alternatively, Multistrokes is a faster but non-editable way for doing many mask clean up paint tasks.

Inputs

The Paint mask node includes a single effect mask input.

– **Effect Mask**: The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input combines the masks. How masks are combined is handled in the Paint mode menu in the Inspector.

Basic Node Setup

The Mask Paint node is useful for painting masks using a more free hand, pressure sensitive style. In the node tree below, the Mask Paint node is used to patch up holes in a Bitmap mask.

![Node tree showing Mask Paint node](image)

A Mask Paint node can be used to repair problematic areas of a matte.

Inspector

![Inspector pane showing Mask Paint controls](image)

Mask Paint controls
As the Controls tab in the Mask Paint node is fundamentally identical to the Paint node, for more detail, see Chapter 51 “Paint Node” in the Fusion Reference Manual or Chapter 112 in the DaVinci Resolve Reference Manual. The only difference between the two nodes is that, as Mask Paint operates on single-channel mask images, there is no Channel Selector control, and all color controls have only a single Alpha value. The Mask tab, however, includes several parameters that are different from the Paint tool, so they are covered below.

The Mask Paint tab

**Mask Tab**
The Mask tab is used to refine the basic mask parameters that do not fall into the category of “panting.” These include how multiple masks are combined, overall softness control, and level control.

**Show View Controls**
The Show View Controls checkbox is used to enable/disable the display of the masks onscreen controls in the viewer. Onscreen controls including, center position, polylines, angles, and others, do not appear when this checkbox is disabled, even when the node is selected.

**Level**
The Level control sets the transparency level of the pixels in the mask channel. When the value is 1.0, the mask is completely opaque (unless it has a soft edge). Lower values cause the mask to be partially transparent. The result is identical to lowering the blend control of an effect.

*NOTE:* Lowering the level of a mask lowers the values of all pixels covered by the mask in the mask channel. For example, if a Circle mask is placed over a Rectangle mask, lowering the level of the Circle mask lowers the values of all of the pixels in the mask channel, even though the Rectangle mask beneath it is still opaque.

**Filter**
This control selects the filtering algorithm used when applying Soft Edge to the mask.

- **Box**: This is the fastest method but at reduced quality. Box is best suited for minimal amounts of blur.
- **Bartlett**: Otherwise known as a Pyramid filter, Bartlett makes a good compromise between speed and quality.
- **Multi-box**: When selecting this filter, the Num Passes slider appears and lets you control the quality. At 1 and 2 passes, results are identical to Box and Bartlett, respectively. At 4 passes and above, results are usually as good as Gaussian, in less time and with no edge “ringing.”
- **Gaussian**: The Gaussian filter uses a true Gaussian approximation and gives excellent results, but it is a little slower than the other filters. In some cases, it can produce an extremely slight edge “ringing” on floating-point pixels.
Soft Edge
Use the Soft Edge slider to blur (feather) the mask, using the selected filter. Higher values cause the edge to fade off well beyond the boundaries of the mask. A value of 0.0 creates a crisp, well-defined edge.

Paint Mode
Connecting a mask to the effect mask input displays the Paint mode menu. The Paint mode is used to determine how the incoming mask for the effect mask input and the mask created in the node are combined.

- **Merge**: Merge is the default for all masks. The new mask is merged with the input mask.
- **Add**: The mask’s values add to the input mask’s values.
- **Subtract**: In the intersecting areas, the new mask values subtract from the input mask’s values.
- **Minimum**: Comparing the input mask’s values and the new mask, this displays the lowest (minimum) value.
- **Maximum**: Comparing the input mask’s values and the new mask, this displays the highest (maximum) value.
- **Average**: This calculates the average (half the sum) of the new mask and the input mask.
- **Multiply**: This multiplies the values of the input mask by the new mask’s values.
- **Replace**: The new mask completely replaces the input mask wherever they intersect. Areas that are zero (completely black) in the new mask do not affect the input mask.
- **Invert**: Areas of the input mask that are covered by the new mask are inverted; white becomes black and vice versa. Gray areas in the new mask are partially inverted.
- **Copy**: This mode completely discards the input mask and uses the new mask for all values.
- **Ignore**: This mode completely discards the new mask and uses the input mask for all values.

Invert
Selecting this checkbox inverts the entire mask. Unlike the Invert Paint mode, the checkbox affects all pixels, regardless of whether the new mask covers them or not.

Common Controls

Image and Settings Tabs
The Image and Settings tabs in the Inspector are also duplicated in other mask nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

Polygon Mask [PLY]

The Polygon node

Polygon Mask Node Introduction
The Polygon mask is most useful for masking objects that do not have a regular shape. When first added to a node, the Polygon mask consists of only Center and Angle controls, which are visible.
onscreen. Points are added to the polyline by clicking in the viewer. Each new point is connected to the last one created.

Like the B-Spline mask tool, the Polygon mask auto-animates. Adding this node to the Node Editor adds a keyframe to the current frame. Moving to a new frame and changing the shape creates a new keyframe and interpolate between the two defined shapes.

**Inputs**

The Polygon mask node includes a single effect mask input.

- **Effect Mask:** The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input combines the masks. How masks are combined is handled in the Paint mode menu in the Inspector.

**Basic Node Setup**

The Polygon node can be used to generate a detailed spline shape or combined with other masks for even more complex shapes. In the node tree below, the Polygon mask is used to generate detailed shape as a solid matte on the Delta Keyer.

A Polygon node generates a detailed shape as a Solid matte.

**Inspector**

**Controls Tab**

The Controls tab is used to refine how the polyline appears after drawing it in the viewer.
Show View Controls
The Show View Controls checkbox is used to enable/disable the display of the mask’s onscreen controls in the viewer. Onscreen controls, including center position, polylines, angles, and others, do not appear when this checkbox is disabled, even when the node is selected.

Level
The Level control sets the transparency level of the pixels in the mask channel. When the value is 1.0, the mask is completely opaque (unless it has a soft edge). Lower values cause the mask to be partially transparent. The result is identical to lowering the blend control of an effect.

**NOTE:** Lowering the level of a mask lowers the values of all pixels covered by the mask in the mask channel. For example, if a Circle mask is placed over a Rectangle mask, lowering the level of the Circle mask lowers the values of all of the pixels in the mask channel, even though the Rectangle mask beneath it is still opaque.

Filter
This control selects the filtering algorithm used when applying Soft Edge to the mask.

- **Box:** This is the fastest method but at reduced quality. Box is best suited for minimal amounts of blur.
- **Bartlett:** Otherwise known as a Pyramid filter, Bartlett makes a good compromise between speed and quality.
- **Multi-box:** When selecting this filter, the Num Passes slider appears and lets you control the quality. At 1 and 2 passes, results are identical to Box and Bartlett, respectively. At 4 passes and above, results are usually as good as Gaussian, in less time and with no edge “ringing.”
- **Gaussian:** The Gaussian filter uses a true Gaussian approximation and gives excellent results, but it is a little slower than the other filters. In some cases, it can produce an extremely slight edge “ringing” on floating-point pixels.

Soft Edge
Use the Soft Edge slider to blur (feather) the mask, using the selected filter. Higher values cause the edge to fade off well beyond the boundaries of the mask. A value of 0.0 creates a crisp, well-defined edge.

Border Width
The Border Width control adjusts the thickness of the mask's edge. When the solid checkbox is toggled on, the border thickens or narrows the mask. When the mask is not solid, the mask shape draws as an outline, and the width uses the Border Width setting.

Paint Mode
Connecting a mask to the effect mask input displays the Paint mode menu. The Paint mode is used to determine how the incoming mask for the effect mask input and the mask created in the node are combined.

- **Merge:** Merge is the default for all masks. The new mask is merged with the input mask.
- **Add:** The mask’s values add to the input mask’s values.
- **Subtract:** In the intersecting areas, the new mask values subtract from the input mask’s values.
- **Minimum:** Comparing the input mask’s values and the new mask, this displays the lowest (minimum) value.
- **Maximum:** Comparing the input mask’s values and the new mask, this displays the highest (maximum) value.
- **Average:** This calculates the average (half the sum) of the new mask and the input mask.
- **Multiply:** This multiplies the values of the input mask by the new mask’s values.
- **Replace:** The new mask completely replaces the input mask wherever they intersect. Areas that are zero (completely black) in the new mask do not affect the input mask.
- **Invert:** Areas of the input mask that are covered by the new mask are inverted; white becomes black and vice versa. Gray areas in the new mask are partially inverted.
- **Copy:** This mode completely discards the input mask and uses the new mask for all values.
- **Ignore:** This mode completely discards the new mask and uses the input mask for all values.

**Invert**

Selecting this checkbox inverts the entire mask. Unlike the Invert Paint mode, the checkbox affects all pixels, regardless of whether the new mask covers them or not.

**Solid**

When the Solid checkbox is enabled, the mask is filled to be transparent (white) unless inverted. When disabled, the spline is drawn as just an outline whose thickness is determined by the Border Width slider.

**Center X and Y**

These controls adjust the position of the polygon spline mask.

**Size**

Use the Size control to adjust the scale of the polygon spline effect mask, without affecting the relative behavior of the points that compose the mask or setting a keyframe in the mask animation.

**X, Y, and Z Rotation**

Use these three controls to adjust the rotation angle of the mask along any axis.

**Fill Method**

The Fill Method menu offers two different techniques for dealing with overlapping regions of a polyline. If overlapping segments in a mask are causing undesirable holes to appear, try switching the setting of this control from Alternate to Non Zero Winding.

**Right-Click Here for Shape Animation**

By default, all polygon spline masks are animated when they are created. The initial keyframe is set to the current time, and any changes to the shape at different times create new keys.

Right-clicking on this label displays a contextual menu that offers options for removing or re-adding animation to the mask, or publishing and connecting the masks together.

**Common Controls**

**Image and Settings Tabs**

The Image and Settings tabs in the Inspector are also duplicated in other mask nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
Adding Points

Adding Points to a polygonal effect mask is relatively simple. Immediately after adding the node to the Node Editor, there are no points, but the tool will be in Click Append mode. Click once in the viewer wherever a point is required for the mask. Continue clicking to draw the shape of the mask. When the shape is complete, click on the initial point again to close the mask.

When the shape is closed, the mode of the polyline will change to Insert and Modify. This allows for the adjusting and adding of additional points to the mask by clicking on segments of the polyline. To lock down the mask’s shape and prevent accidental changes, switch the Polyline mode to Done using the Polyline toolbar or contextual menu.

B-Spline Mask Polygon toolbar

When a Polygon (or B-Spline) mask is added to a node, a toolbar appears above the viewer, offering easy access to modes. Hold the pointer over any button in the toolbar to display a tooltip that describes that button’s function.

- **Click**: Click is the default option when creating a polyline (or B-Spline) mask. It is a Bézier style drawing tool. Clicking sets a control point and appends the next control point when you click again in a different location.
- **Draw**: Draw is a freehand drawing tool. It creates a mask similar to drawing with a pencil on paper. You can create a new mask using the Draw tool, or you can extend an existing open spline by clicking the Draw tool and starting to draw from the last control point.
- **Insert**: Insert adds a new control point along the spline.
- **Modify**: Modify allows you to safely move or smooth any exiting point along a spline without worrying about adding new points accidentally.
- **Done**: Prevents any point along the spline from being moved or modified. Also, new points cannot be added. You can, however, move and rotate the entire spline.
- **Closed**: Closes an open spline.
- **Smooth**: Changes the selected control point from a linear to a smooth curve.
- **Linear**: Changes the selected control point from a smooth curve to linear.
- **Select All**: Selects all the control points on the spline.
- **Keys**: Shows or hides the control points along the spline.
- **Handles**: Shows or hides the Bézier handles along the polyline.
- **Shape**: Places a reshape rectangle around the selected spline shape. Using the reshape rectangle, you can deform groups of control points or entire shapes much easier than modifying each point.
- **Delete**: Deletes the selected control point(s).
- **Reduce**: Opens a Freehand precision window that can be used to reduce the number of controls points on a spline. This can make the paint stroke easier to modify, especially if it has been created using the Draw tool.
- **Publish menu**: You can use the publish menu to select between publishing the control points or the path. Publishing is a form of parameter linking, it makes the selected item available for use by other controls. It also allows you to attach a control point to a tracker.
- **Follow Points**: Allows a selected point to follow the path of a published point. The point follows the published point using an offset position.
– **Double Poly**: Allows softening part of the spline curve while keeping other portions of the curve sharp. The double polyline is composed of two shapes, an inner and outer shape. The inner shape is the original shape from the single polyline, whereas the outer shape is used to determine the spread of the softness. The further the outer shape gets from the inner shape, the softer that segment of the shape becomes. Both polylines start with exactly the same shape as the original single polyline, keeping the mask sharp to start. Any animation already applied to the shape remains. To select the outer shape, press the Tab key to cycle between the onscreen controls until the dashed outline is visible, or you can select the outer polyline using the contextual menu’s Controls > Outer Polygon menu.

– **Multiframe**: Multiframe is a method of adjusting control points across multiple keyframes. The default setting of none only adjusts the control point of a spline on the current keyframe. Setting the menu to All adjusts the controls point for all keyframes. Prev settings adjust the current and previous keyframe while Next adjusts the current and next keyframe.

– **Onion Skinning**: Enabling onion skinning displays a mix in the viewer of the spline animation. It is useful when aligning spline animation and motion. Selecting Onion Skin Settings from the drop down menu allows you to set the number of overlapping frames.

– **Roto Assist**: Enable the Roto Assist button when you begin painting with the Polyline Stroke tool. The polyline points snap to the closest edge as you click to add points to the shape. A cyan outline indicates the points that have snapped to an edge. There are three main Roto Assist options selectable through the drop down menu:
  - **Multiple Points**: When enabled, a single click on a high contrast edge adds multiple points to define the entire edge, instead of having to add each point individually. This is a one time only click. The second click reverts to single point edge detection.
  - **Distance 8**: Opens a dialog where you can set the pixel range within which searching for an edge takes place.
  - **Reset**: Used for resetting the snap attribute of all snapped points. After resetting, the points become unavailable for tracking.

Change the way the toolbar is displayed by right-clicking on the toolbar and selecting from the options displayed in the toolbar’s contextual menu. The functions of the buttons in this toolbar are explained in depth in the Polylines chapter.

### Ranges Mask [RNG]

The Ranges node

### Ranges Mask Node Introduction

Similar to Bitmap mask, the Ranges mask allows images from the node tree to act as masks for nodes and effects. Instead of creating a simple luminance-based mask from a given channel, Ranges allows spline-based selection of low, mid and high ranges, akin to Color Corrector.
Inputs

The Ranges mask node includes two inputs in the Node Editor.

- **Input**: The orange input accepts a 2D image from which the mask will be created.
- **Effect Mask**: The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input combines the masks. How masks are combined is handled in the Paint mode menu in the Inspector.

Basic Node Setup

The Ranges node is not required for connecting an image into the effect mask input, but like the Bitmap node, it does provide options that are otherwise unavailable. It allows for selecting channels other than RGBA for the mask, as well as softness and clipping. In the node tree below, the Ranges node takes the composite out of the merge, creating a mask for the color correction.

![Node tree](image)

A Ranges node selects a specific range in the image to create a mask.

Inspector

![Inspector interface](image)

Ranges Mask controls
Controls Tab
The Controls tab is used to refine how the image connected to the orange input converts into the ranges mask.

Show View Controls
The Show View Controls checkbox is used to enable/disable the display of the mask’s onscreen controls in the viewer. Onscreen controls, including center position, polylines, angles, and others, do not appear when this checkbox is disabled, even when the node is selected.

Level
The Level control sets the transparency level of the pixels in the mask channel. When the value is 1.0, the mask is completely opaque (unless it has a soft edge). Lower values cause the mask to be partially transparent. The result is identical to lowering the blend control of an effect.

**NOTE:** Lowering the level of a mask lowers the values of all pixels covered by the mask in the mask channel. For example, if a Circle mask is placed over a Rectangle mask, lowering the level of the Circle mask lowers the values of all of the pixels in the mask channel, even though the Rectangle mask beneath it is still opaque.

Filter
This control selects the filtering algorithm used when applying Soft Edge to the mask.

- **Box:** This is the fastest method but at reduced quality. Box is best suited for minimal amounts of blur.
- **Bartlett:** Otherwise known as a Pyramid filter, Bartlett makes a good compromise between speed and quality.
- **Multi-box:** When selecting this filter, the Num Passes slider appears and lets you control the quality. At 1 and 2 passes, results are identical to Box and Bartlett, respectively. At 4 passes and above, results are usually as good as Gaussian, in less time and with no edge “ringing.”
- **Gaussian:** The Gaussian filter uses a true Gaussian approximation and gives excellent results, but it is a little slower than the other filters. In some cases, it can produce an extremely slight edge “ringing” on floating-point pixels.

Soft Edge
Use the Soft Edge slider to blur (feather) the mask, using the selected filter. Higher values cause the edge to fade off well beyond the boundaries of the mask. A value of 0.0 creates a crisp, well-defined edge.

Paint Mode
Connecting a mask to the effect mask input displays the Paint mode menu. The Paint mode is used to determine how the incoming mask for the effect mask input and the mask created in the node are combined.

- **Merge:** Merge is the default for all masks. The new mask is merged with the input mask.
- **Add:** The mask’s values add to the input mask’s values.
- **Subtract:** In the intersecting areas, the new mask values subtract from the input mask’s values.
- **Minimum:** Comparing the input mask’s values and the new mask, this displays the lowest (minimum) value.
- **Maximum:** Comparing the input mask’s values and the new mask, this displays the highest (maximum) value.
- **Average:** This calculates the average (half the sum) of the new mask and the input mask.
– **Multiply**: This multiplies the values of the input mask by the new mask's values.

– **Replace**: The new mask completely replaces the input mask wherever they intersect. Areas that are zero (completely black) in the new mask do not affect the input mask.

– **Invert**: Areas of the input mask that are covered by the new mask are inverted; white becomes black and vice versa. Gray areas in the new mask are partially inverted.

– **Copy**: This mode completely discards the input mask and uses the new mask for all values.

– **Ignore**: This mode completely discards the new mask and uses the input mask for all values.

**Invert**

Selecting this checkbox inverts the entire mask. Unlike the Invert Paint mode, the checkbox affects all pixels, regardless of whether the new mask covers them or not.

**Center X and Y**

These controls adjust the position of the ranges mask.

**Fit Input**

This menu is used to select how the image source is treated if it does not fit the dimensions of the generated mask.

For example, below, a 720 x 576 image source (yellow) is used to generate a 1920 x 1080 mask (gray).

– **Crop**: If the image source is smaller than the generated mask, it is placed according to the X/Y controls, masking off only a portion of the mask. If the image source is larger than the generated mask it is placed according to the X/Y controls and cropped off at the borders of the mask.

– **Stretch**: The image source is stretched in X and Y to accommodate the full dimensions of the generated mask. This might lead to visible distortions of the image source.

– **Inside**: The image source is scaled uniformly until one of its dimensions (X or Y) fits the inside dimensions of the mask. Depending on the relative dimensions of the image source and mask background, either the image source’s width or height may be cropped to fit the respective dimension of the mask.
– **Width**: The image source is scaled uniformly until its width (X) fits the width of the mask. Depending on the relative dimensions of the image source and mask, the image source’s Y dimension might not fit the mask’s Y dimension, resulting in either cropping of the image source in Y or the image source not covering the mask’s height entirely.

![My Mask](image1)

– **Height**: The image source is scaled uniformly until its height (Y) fits the height of the mask. Depending on the relative dimensions of the image source and mask, the image source’s X dimension might not fit the mask’s X dimension, resulting in either cropping of the image source in X or the image source not covering the mask’s width entirely.

![My Mask](image2)

– **Outside**: The image source is scaled uniformly until one of its dimensions (X or Y) fits the outside dimensions of the mask. Depending on the relative dimensions of the image source and mask, either the image source’s width or height may be cropped or not fit the respective dimension of the mask.

![My Mask](image3)

**Channel**

The Channel menu determines the Channel of the input image used to create the mask._choices include the red, green, blue, and alpha channels; the hue, luminance, or saturation values; or the auxiliary coverage channel of the input image (if one is provided).

**Shadows/Midtones/Highlights**

These buttons are used to select which range is output by the node as a mask. White pixels represent pixels that are considered to be part of the range, and black pixels are not included in the range. For example, choosing Shadows would show pixels considered to be shadows as white, and pixels that are not shadows as black. Mid gray pixels are only partly in the range and do not receive the full effect of any color adjustments to that range.
Channel
The Channel selection buttons shown in this tab can be used to extract a mask from the range of a specific color channel. By default, Fusion uses the luminance channel when the color ranges are examined.

Mini Spline Editor
The extent of the ranges is selected by manipulating the spline handles. There are four spline points, each with one Bézier handle. The two handles at the top represent the start of the shadow and highlight ranges; the two handles at the bottom represent the end of the range. The Bézier handles are used to control the falloff.

The midtones range has no specific control, since its range is understood to be the space between the shadow and highlight ranges. In other words, after low and high masks have been applied, midtones are everything else.

The X and Y text controls below the Mini Spline Editor can be used to enter precise positions for the selected Bézier point or handle.

Presets
This sets the splines to two commonly-used configurations. The Simple button gives a straightforward linear-weighted selection, while the Smooth button uses a more natural falloff.

Common Controls
Image and Settings Tabs
The Image and Settings tabs in the Inspector are also duplicated in other mask nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

Rectangle Mask [REC]

Rectangle Mask Node Introduction
The Rectangle mask creates simple square or rectangular masks. By default, it creates a rectangle in the same aspect ratio as the comp, but independent control is offered over the width, height, and angle, providing for a wide variety of rectangular shapes.

Inputs
The Rectangle mask node includes a single effect mask input.

– **Effect Mask**: The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input combines the masks. How masks are combined is handled in the Paint mode menu in the Inspector.
Basic Node Setup

The Rectangle mask node is useful for generating rectangular shapes. Below, the Rectangle mask is used to generate a colored square by cutting a square shape from a background node.

![A Rectangle mask node creating a colored square by masking a Background node](image)

Inspector

Controls Tab

The Controls tab is used to refine how the rectangle appears after drawing it in the viewer.

Show View Controls

The Show View Controls checkbox is used to enable/disable the display of the mask's onscreen controls in the viewer. Onscreen controls, including center position, polylines, angles, and others, do not appear when this checkbox is disabled, even when the node is selected.

Level

The Level control sets the transparency level of the pixels in the mask channel. When the value is 1.0, the mask is completely opaque (unless it has a soft edge). Lower values cause the mask to be partially transparent. The result is identical to lowering the Blend control of an effect.

**NOTE:** Lowering the level of a mask lowers the values of all pixels covered by the mask in the mask channel. For example, if a Circle mask is placed over a Rectangle mask, lowering the level of the Circle mask lowers the values of all the pixels in the mask channel, even though the Rectangle mask beneath it is still opaque.
Filter
This control selects the filtering algorithm used when applying Soft Edge to the mask.

- **Box**: This is the fastest method but at reduced quality. Box is best suited for minimal amounts of blur.
- **Bartlett**: Otherwise known as a Pyramid filter, Bartlett makes a good compromise between speed and quality.
- **Multi-box**: When selecting this filter, the Num Passes slider appears and lets you control the quality. At 1 and 2 passes, results are identical to Box and Bartlett, respectively. At 4 passes and above, results are usually as good as Gaussian, in less time and with no edge “ringing.”
- **Gaussian**: The Gaussian filter uses a true Gaussian approximation and gives excellent results, but it is a little slower than the other filters. In some cases, it can produce an extremely slight edge “ringing” on floating-point pixels.

Soft Edge
Use the Soft Edge slider to blur (feather) the mask, using the selected filter. Higher values cause the edge to fade off well beyond the boundaries of the mask. A value of 0.0 creates a crisp, well-defined edge.

Border Width
The Border Width control adjusts the thickness of the mask’s edge. When the solid checkbox is toggled on, the border thickens or narrows the mask. When the mask is not solid, the mask shape draws as an outline, and the width uses the Border Width setting.

Paint Mode
Connecting a mask to the effect mask input displays the Paint mode menu. The Paint mode is used to determine how the incoming mask for the effect mask input and the mask created in the node are combined.

- **Merge**: Merge is the default for all masks. The new mask is merged with the input mask.
- **Add**: The mask’s values add to the input mask’s values.
- **Subtract**: In the intersecting areas, the new mask values subtract from the input mask’s values.
- **Minimum**: Comparing the input mask’s values and the new mask, this displays the lowest (minimum) value.
- **Maximum**: Comparing the input mask’s values and the new mask, this displays the highest (maximum) value.
- **Average**: This calculates the average (half the sum) of the new mask and the input mask.
- **Multiply**: This multiplies the values of the input mask by the new mask’s values.
- **Replace**: The new mask completely replaces the input mask wherever they intersect. Areas that are zero (completely black) in the new mask do not affect the input mask.
- **Invert**: Areas of the input mask that are covered by the new mask are inverted: white becomes black and vice versa. Gray areas in the new mask are partially inverted.
- **Copy**: This mode completely discards the input mask and uses the new mask for all values.
- **Ignore**: This mode completely discards the new mask and uses the input mask for all values.

Invert
Selecting this checkbox inverts the entire mask. Unlike the Invert Paint mode, this checkbox affects all pixels, regardless of whether the new mask covers them.
**Solid**

When the Solid checkbox is enabled, the mask is filled to be transparent (white) unless inverted. When disabled, the spline is drawn as just an outline whose thickness is determined by the Border Width slider.

**Center X and Y**

These controls adjust the position of the Rectangle mask.

**Width and Height**

Use these controls to change the X or Y scale of the rectangular effect mask independently of each other. Alternatively, drag the edges of the rectangle in the viewer to interactively adjust its size.

**Corner Radius**

Corner Radius allows the corners of the Rectangle mask to be rounded. A value of 0.0 is not rounding at all, which means that the rectangle has sharp corners. A value of 1.0 applies the maximum amount of rounding to the corners.

**Angle**

Change the rotation angle of an effect mask by moving the Angle control left or right. Values can be entered in the provided input boxes. Alternatively, use the onscreen controls by dragging the little circle at the end of the dashed angle line to interactively adjust the rotation of the ellipse.

**Common Controls**

**Image and Settings Tabs**

The Image and Settings tabs in the Inspector are also duplicated in other mask nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

---

**Triangle Mask [TRI]**

The Triangle node

**Triangle Mask Node Introduction**

The Triangle mask creates simple triangular masks. It is unique in that it has no Center, Size, or Angle control. Unlike most other types of masks, all three points of the triangle can attach to a tracker or motion path.

**Inputs**

The Triangle mask node includes a single effect mask input.

- **Effect Mask**: The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input combines the masks. How masks are combined is handled in the Paint mode menu in the Inspector.
Basic Node Setup

The Triangle mask node is useful for generating triangular shapes. Below, the Triangle mask is used to generate a colored triangle by cutting a triangular shape from a background node.

![Triangle mask node creating a colored Triangle shape by masking a Background node](image)

Inspector

Controls Tab

The Controls tab is used to refine how the triangle appears after drawing it in the viewer.

Show View Controls

The Show View Controls checkbox is used to enable/disable the display of the mask’s onscreen controls in the viewer. Onscreen controls, including center position, polylines, angles, and others, do not appear when this checkbox is disabled, even when the node is selected.

Level

The Level control sets the transparency level of the pixels in the mask channel. When the value is 1.0, the mask is completely opaque (unless it has a soft edge). Lower values cause the mask to be partially transparent. The result is identical to lowering the Blend control of an effect.

**NOTE:** Lowering the level of a mask lowers the values of all pixels covered by the mask in the mask channel. For example, if a Circle mask is placed over a Rectangle mask, lowering the level of the Circle mask lowers the values of all the pixels in the mask channel, even though the Rectangle mask beneath it is still opaque.
Filter
This control selects the filtering algorithm used when applying Soft Edge to the mask.

- **Box**: This is the fastest method but at reduced quality. Box is best suited for minimal amounts of blur.
- **Bartlett**: Otherwise known as a Pyramid filter, Bartlett makes a good compromise between speed and quality.
- **Multi-box**: When selecting this filter, the Num Passes slider appears and lets you control the quality. At 1 and 2 passes, results are identical to Box and Bartlett, respectively. At 4 passes and above, results are usually as good as Gaussian, in less time and with no edge “ringing.”
- **Gaussian**: The Gaussian filter uses a true Gaussian approximation and gives excellent results, but it is a little slower than the other filters. In some cases, it can produce an extremely slight edge “ringing” on floating-point pixels.

Soft Edge
Use the Soft Edge slider to blur (feather) the mask, using the selected filter. Higher values cause the edge to fade off well beyond the boundaries of the mask. A value of 0.0 creates a crisp, well-defined edge.

Border Width
The Border Width control adjusts the thickness of the mask’s edge. When the solid checkbox is toggled on, the border thickens or narrows the mask. When the mask is not solid, the mask shape draws as an outline, and the width uses the Border Width setting.

Paint Mode
Connecting a mask to the effect mask input displays the Paint mode menu. The Paint mode is used to determine how the incoming mask for the effect mask input and the mask created in the node are combined.

- **Merge**: Merge is the default for all masks. The new mask is merged with the input mask.
- **Add**: The mask’s values add to the input mask’s values.
- **Subtract**: In the intersecting areas, the new mask values subtract from the input mask’s values.
- **Minimum**: Comparing the input mask’s values and the new mask, this displays the lowest (minimum) value.
- **Maximum**: Comparing the input mask’s values and the new mask, this displays the highest (maximum) value.
- **Average**: This calculates the average (half the sum) of the new mask and the input mask.
- **Multiply**: This multiplies the values of the input mask by the new mask’s values.
- **Replace**: The new mask completely replaces the input mask wherever they intersect. Areas that are zero (completely black) in the new mask do not affect the input mask.
- **Invert**: Areas of the input mask that are covered by the new mask are inverted: white becomes black and vice versa. Gray areas in the new mask are partially inverted.
- **Copy**: This mode completely discards the input mask and uses the new mask for all values.
- **Ignore**: This mode completely discards the new mask and uses the input mask for all values.

Invert
Selecting this checkbox inverts the entire mask. Unlike the Invert Paint mode, this checkbox affects all pixels, regardless of whether the new mask covers them.
Solid
When the Solid checkbox is enabled, the mask is filled to be transparent (white) unless inverted. When disabled, the spline is drawn as just an outline whose thickness is determined by the Border Width slider.

Point 1, Point 2, Point 3
These controls show the position coordinates of the three corners of the triangle. Each point can be published, connected to other controls, animated with a path, or attached to trackers. These tasks are performed by right-clicking the Position control or directly on the point in the viewer.

Common Controls
Image and Settings Tabs
The Image and Settings tabs in the Inspector are also duplicated in other mask nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

Wand Mask [WND]

Wand Mask Node Introduction
The Wand mask masks an image based on a wand-style selection, similar to the Magic Wand tool found in Adobe Photoshop. As with a Bitmap mask, any image in the composition can be the source of the mask. Generally, the default is most useful, where the source image is the input of the node to which the mask is applied.

When adding a Wand mask to a node, a crosshair appears in the viewers. This crosshair should be positioned in the image to select the color used to create the Wand mask. The mask is created by examining the pixel color beneath the selection point and adding that color to the mask. The mask then expands to examine the pixels surrounding the selection point. Surrounding pixels are added to the mask if they are the same color. The mask stops expanding when no connecting pixels fall within the color range of the mask.

Inputs
The Wand mask node includes two inputs in the Node Editor.

- **Input:** The orange input accepts a 2D image from which the mask is created.
- **Effect Mask:** The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input combines the masks. How masks are combined is handled in the Paint mode menu in the Inspector.

Basic Node Setup
The Wand mask node is not required for connecting an image into the effect mask input, but like the Bitmap node, it does provide options that are otherwise unavailable. It allows for selecting channels other than RGBA for the mask, as well as softness and clipping. In the node tree below, the Wand node takes the composite out of the merge, creating a mask for the color correction.
A Wand node selects a specific area in the image to create a mask.

**Inspector**

**Controls Tab**

The Controls tab is used to refine how the mask appears after the Wand makes a selection in the viewer.

**Show View Controls**

The Show View Controls checkbox is used to enable/disable the display of the mask’s onscreen controls in the viewer. Onscreen controls, including center position, polylines, angles, and others, do not appear when this checkbox is disabled, even when the node is selected.

**Level**

The Level control sets the transparency level of the pixels in the mask channel. When the value is 1.0, the mask is completely opaque (unless it has a soft edge). Lower values cause the mask to be partially transparent. The result is identical to lowering the Blend control of an effect.

**NOTE:** Lowering the level of a mask lowers the values of all pixels covered by the mask in the mask channel. For example, if a Circle mask is placed over a Rectangle mask, lowering the level of the Circle mask lowers the values of all the pixels in the mask channel, even though the Rectangle mask beneath it is still opaque.
Filter
This control selects the filtering algorithm used when applying Soft Edge to the mask.

- **Box**: This is the fastest method but at reduced quality. Box is best suited for minimal amounts of blur.

- **Bartlett**: Otherwise known as a Pyramid filter, Bartlett makes a good compromise between speed and quality.

- **Multi-box**: When selecting this filter, the Num Passes slider appears and lets you control the quality. At 1 and 2 passes, results are identical to Box and Bartlett, respectively. At 4 passes and above, results are usually as good as Gaussian, in less time and with no edge “ringing.”

- **Gaussian**: The Gaussian filter uses a true Gaussian approximation and gives excellent results, but it is a little slower than the other filters. In some cases, it can produce an extremely slight edge “ringing” on floating-point pixels.

Soft Edge
Use the Soft Edge slider to blur (feather) the mask, using the selected filter. Higher values cause the edge to fade off well beyond the boundaries of the mask. A value of 0.0 creates a crisp, well-defined edge.

Paint Mode
Connecting a mask to the effect mask input displays the Paint mode menu. The Paint mode is used to determine how the incoming mask for the effect mask input and the mask created in the node are combined.

- **Merge**: Merge is the default for all masks. The new mask is merged with the input mask.

- **Add**: The mask’s values add to the input mask’s values.

- **Subtract**: In the intersecting areas, the new mask values subtract from the input mask’s values.

- **Minimum**: Comparing the input mask’s values and the new mask, this displays the lowest (minimum) value.

- **Maximum**: Comparing the input mask’s values and the new mask, this displays the highest (maximum) value.

- **Average**: This calculates the average (half the sum) of the new mask and the input mask.

- **Multiply**: This multiplies the values of the input mask by the new mask’s values.

- **Replace**: The new mask completely replaces the input mask wherever they intersect. Areas that are zero (completely black) in the new mask do not affect the input mask.

- **Invert**: Areas of the input mask that are covered by the new mask are inverted; white becomes black and vice versa. Gray areas in the new mask are partially inverted.

- **Copy**: This mode completely discards the input mask and uses the new mask for all values.

- **Ignore**: This mode completely discards the new mask and uses the input mask for all values.

Invert
Selecting this checkbox inverts the entire mask. Unlike the Invert Paint mode, this checkbox affects all pixels, regardless of whether the new mask covers them.

Selection Point
The Selection Point is a pair of X and Y coordinates that determines where in the source image the Wand mask derives its initial color sample. This control is also seen as a crosshair in the viewers. The selection point can be positioned manually, connected to a tracker, path, or other expressions.
Color Space
The Color Space button group determines the color space used when selecting the source color for the mask. The Wand mask can operate in RGB, YUV, HLS, or LAB color spaces.

Channel
The Channel button group is used to select whether the color that is masked comes from all three color channels of the image, the alpha channel, or an individual channel only.

The exact labels of the buttons depend on the color space selected for the Wand mask operation. If the color space is RGB, the options are R, G, or B. If YUV is the color space, the options are Y, U, or V.

Range
The Range slider controls the range of colors around the source color that are included in the mask. If the value is left at 0.0, only pixels of the same color as the source are considered part of the mask. The higher the value, the more that similar colors in the source are considered to be wholly part of the mask.

Range Soft Edge
The Range Soft Edge determines the falloff range of the colors selected. Any pixel within the range defined above are treated as 100% within the mask. If the soft range is set to 0.0, no other pixels are considered for the mask. Increasing the soft range increases the number of colors close to, but not quite within, the range included in the mask. These pixels are semitransparent in the mask.

The Common Controls
Nodes that create masks share several identical controls in the Inspector. This section describes controls that are common among mask nodes.

Inspector

Image Tab
The controls in this tab set the resolution and clipping method used by the generated mask.

Output Size
The Output size menu sets the resolution of the mask node’s output. The three options include the default resolution of the comp, the source input’s resolution on nodes that have an input, or a custom resolution.

Custom
When selecting Custom from the Output Size menu, the width, height, and pixel aspect of the mask created are locked to values defined in the composition’s Frame Format preferences. If the Frame Format preferences change, the resolution of the mask produced is changed to match. Disabling this option can be useful for building a composition at a different resolution than the eventual target resolution for the final render.
– **Width and Height**: This pair of controls is used to set the Width and Height dimensions of the mask to be created.

– **Pixel Aspect**: This control is used to specify the Pixel Aspect ratio of the created mask. An aspect ratio of 1:1 would generate a square pixel with the same dimensions on either side (like a computer monitor), and an aspect of 0.91 would create a slightly rectangular pixel (like an NTSC monitor).

– **Depth**: The Depth drop-down menu is used to set the pixel color depth of the image created by the mask. 32-bit pixels require four times the memory of 8-bit pixels but have far greater accuracy. Float pixels allow high dynamic range values outside the normal 0..1 range, for representing colors that are brighter than white or darker than black.

**NOTE**: Right-click on the Width, Height, or Pixel Aspect controls to display a menu listing the file formats defined in the preferences Frame Format tab. Selecting any of the listed options sets the width, height, and pixel aspect to the values for that format.

**Clipping Mode**

This option determines how the domain of definition rendering handles edges. The Clipping mode is most important when blur or softness is applied, which may require samples from portions of the image outside the current domain.

– **Frame**: The default option is Frame, which automatically sets the node’s domain of definition to use the full frame of the image, effectively ignoring the current domain of definition. If the upstream DoD is smaller than the frame, the remaining area in the frame is treated as black/transparent.

– **None**: Setting this option to None does not perform any source image clipping. Any data required to process the node’s effect that would usually be outside the upstream DoD is treated as black/transparent.
Settings Tab
The Settings tab in the Inspector can be found on every tool in the Mask category. The Settings controls are even found on third-party plug-in tools. The controls are consistent and work the same way for each tool, although some tools do include one or two individual options, which are also covered here.

Motion Blur
- Motion Blur: This toggles the rendering of Motion Blur on the tool. When this control is toggled on, the tool’s predicted motion is used to produce the motion blur caused by the virtual camera’s shutter. When the control is toggled off, no motion blur is created.
- Quality: Quality determines the number of samples used to create the blur. A quality setting of 2 causes Fusion to create two samples to either side of an object’s actual motion. Larger values produce smoother results but increase the render time.
- Shutter Angle: Shutter Angle controls the angle of the virtual shutter used to produce the motion blur effect. Larger angles create more blur but increase the render times. A value of 360 is the equivalent of having the shutter open for one full frame exposure. Higher values are possible and can be used to create interesting effects.
- Center Bias: Center Bias modifies the position of the center of the motion blur. This allows for the creation of motion trail effects.
- Sample Spread: Adjusting this control modifies the weighting given to each sample. This affects the brightness of the samples.

Use GPU
The Use GPU menu has three settings. Setting the menu to Disable turns off hardware-accelerated rendering using the graphics card in your computer. Enabled uses the hardware, and Auto uses a capable GPU if one is available and falls back to software rendering when a capable GPU is not available.

Comments
The Comments field is used to add notes to a tool. Click in the empty field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

Scripts
Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
Chapter 108

Matte Nodes

This chapter details the Matte nodes available in Fusion.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

Alpha Divide [ADV] 2083
Alpha Multiply [AML] 2084
Chroma Keyer [CKY] 2085
Clean Plate 2090
Delta Keyer 2093
Difference Keyer [DfK] 2101
Luma Keyer [LKY] 2105
Matte Control [MAT] 2108
Primatte [Pri] 2113
How to Key with Primatte 2124
Ultra Keyer [UKY] 2126
The Common Controls 2132
Alpha Divide Node Introduction

As the name gives away, the Alpha Divide’s sole purpose is to divide an incoming image’s color channels by its alpha channel. When you color correct an image that contains a premultiplied alpha channel, first apply an Alpha Divide node before any color correction node to create a non-premultiplied image. Then you can perform the color correction. After the color correction, add an Alpha Multiply node to return the image to its premultiplied state.

Inputs

The Alpha Divide node includes two inputs in the Node Editor.

- **Input**: The orange input accepts a 2D image with a premultiplied Alpha.
- **Effect Mask**: The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input limits the pixels where the Alpha divide occurs. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

The Alpha Divide node is placed before any color correction is done to an image with a premultiplied Alpha channel. Here the MediaIn node is assumed to have a premultiplied Alpha channel. The Alpha Divide node is inserted, and then color correction nodes operate on the “straight” Alpha. An Alpha Multiply node is placed at the end of the chain to premultiply the Alpha channel again. If only a single color correction node is used, then the Pre-Divide/Post-Multiply checkbox on the Options tab can be used in place of the Alpha Divide/Alpha Multiple nodes.

Inspector

This node has no controls.
Alpha Multiply [AML]

The Alpha Multiply node

Alpha Multiply Node Introduction

As the name gives away, the Alpha Multiply’s sole purpose is to multiply an image’s color channels by its alpha channel. When you color correct an image that contains a premultiplied alpha channel, first apply an Alpha Divide node before any color correction node to create a non-premultiplied image. Then you can perform the color correction. After the color correction, add an Alpha Multiply node to return the image to its premultiplied state.

Inputs

The Alpha Multiply node includes two inputs in the Node Editor.

– **Input:** The orange input accepts a 2D image with a “straight” or non-premultiplied alpha.

– **Effect Mask:** The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input limits the pixels where the Alpha multiply occurs. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

The Alpha Multiply node is placed after color correction is done to an image with a premultiplied Alpha channel. Here the Median node is assumed to have a premultiplied Alpha channel. The Alpha Divide node is inserted, and then color correction nodes operate on the “straight” Alpha. An Alpha Multiply node is placed at the end of the chain to premultiply the Alpha channel again. If only a single color correction node is used, then the Pre-Divide/Post-Multiply checkbox on the Options tab can be used in place of the Alpha Divide/Alpha Multiple nodes.

Inspector

This node has no controls.
Chroma Keyer [CKY]

The Chroma Keyer node creates an alpha channel (matte) for an image by removing selected colors from the scene. Unlike the Delta Keyer or Primatte, which use specific optimizations for keying from blue and green colors, the Chroma Keyer works equally well with any color.

NOTE: When working with blue- or green-screen shots, it is best to use the Delta Keyer or Primatte node, rather than the more general purpose Chroma Keyer node.

Inputs

The Chroma Keyer node includes four inputs in the Node Editor.

- **Input**: The orange input accepts a 2D image that contains the color you want to be keyed for transparency.
- **Garbage Matte**: The gray garbage matte input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input causes areas of the image that fall within the matte to be made transparent. The garbage matte is applied directly to the alpha channel of the image.
- **Solid Matte**: The white solid matte input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input causes areas of the image that fall within the matte to be fully opaque.
- **Effect Mask**: The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input limits the pixels where the alpha multiply occurs. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

The Chroma Keyer node takes in a 2D image like the MediaIn node below and removes a color that you identify by dragging over it in the viewer. The result is that the selected color is replaced with transparency, allowing you to composite the image as the foreground in a Merge node.
Inspector

The Chroma Key tab

Chroma Key Tab
The Chroma Key tab is used to make the initial selection of color for keying.

Key Type
The Key Type menu determines the selection method used for the matte creation.
  – Chroma: The Chroma method creates a matte based on the RGB values of the selected color range.
  – Color: The Color method creates a matte based on the hue of the selected color range.

Color Range
Colors are made transparent by selecting the Chroma Keyer node in the node tree, and then dragging a selection around the colors in the viewer. The range controls update automatically to represent the current color selection. You can tweak the range sliders slightly, although most often selecting colors in the displays is all that is required.

Lock Color Picking
When this checkbox is activated, selecting colors from the viewer is disabled to prevent accidental addition to the range. It is a good idea to activate this checkbox once you make the color selection for the matte. All other controls in the node remain editable.

Soft Range
This control softens the selected color range, adding additional colors into the matte.

Reset Color Ranges
Clicking this button resets the Chroma Keyer’s range controls, discarding all color selections. All other sliders and controls maintain their values.
The Image tab primarily handles removing spill color on the foreground subject. Color spill occurs when light containing the color you are removing is reflected onto the foreground subject.

**Spill Color**
This menu selects the color used as the base for all spill suppression techniques.

**Spill Suppression**
This slider sets the amount of spill suppression applied to the foreground subject. When this slider is set to 0, no spill suppression is applied.

**Spill Method**
This menu selects the strength of the algorithm used to apply spill suppression to the image.
- **None**: None is selected when no spill suppression is required.
- **Rare**: This removes very little of the spill color and is the lightest of all methods.
- **Medium**: This works best for green screens.
- **Well Done**: This works best for blue screens.
- **Burnt**: This works best for blue. Use this mode only for very troublesome shots. Most likely you will have to add strong color correction after the key to get, for example, your skin tones back.

**Fringe Gamma**
This control is used to adjust the brightness of the fringe or halo that surrounds the keyed image.

**Fringe Size**
This expands and contracts the size of the fringe or halo surrounding the keyed image.

**Fringe Shape**
Fringe Shape forces the fringe toward the external edge of the image or toward the inner edge of the fringe. Its effect is most noticeable while the Fringe Size slider’s value is large.

**Cyan/Red, Magenta/Green, and Yellow/Blue**
Use these three controls to color correct the fringe of the image. This is useful for correcting semitransparent pixels that still contain color from the original background to match the new background.

The Chroma Key Matte tab
Matte Tab
The Matte tab refines the softness, density, and overall fit of the resulting matte.

Filter
This control selects the filtering algorithm used when applying blur to the matte.
- **Box**: This is the fastest method but at reduced quality. Box is best suited for minimal amounts of blur.
- **Bartlett**: Otherwise known as a Pyramid filter, Bartlett makes a good compromise between speed and quality.
- **Multi-box**: When selecting this filter, the Num Passes slider appears and lets you control the quality. At 1 and 2 passes, results are identical to Box and Bartlett, respectively. At 4 passes and above, results are usually as good as Gaussian, in less time and with no edge “ringing.”
- **Gaussian**: The Gaussian filter uses a true Gaussian approximation and gives excellent results, but it is a little slower than the other filters. In some cases, it can produce an extremely slight edge “ringing” on floating-point pixels.

Blur
Matte Blur blurs the edge of the matte based on the Filter menu setting. A value of zero results in a sharp, cutout-like hard edge. The higher the value, the more blur applied to the matte.

Clipping Mode
This option determines how edges are handled when performing domain of definition rendering. This is profoundly important when blurring the matte, which may require samples from portions of the image outside the current domain.
- **Frame**: The default option is Frame, which automatically sets the node’s domain of definition to use the full frame of the image, effectively ignoring the current domain of definition. If the upstream DoD is smaller than the frame, the remaining area in the frame will be treated as black/transparent.
- **Domain**: Setting this option to Domain will respect the upstream domain of definition when applying the node’s effect. This can have adverse clipping effects in situations where the node employs a large filter.
- **None**: Setting this option to None will not perform any source image clipping at all. This means that any data required to process the node’s effect that would normally be outside the upstream DoD will be treated as black/transparent.

Contract/Expand
This slider shrinks or grows the semitransparent areas of the matte. Values above 0.0 expand the matte, while values below 0.0 contract it.
This control is usually used in conjunction with the Matte Blur to take the hard edge of a matte and reduce fringing. Since this control affects only semitransparent areas, it will have no effect on a matte’s hard edge.

Gamma
Matte Gamma raises or lowers the values of the matte in the semitransparent areas. Higher values cause the gray areas to become more opaque, and lower values cause the gray areas to become more transparent. Completely black or white regions of the matte remain unaffected.
Since this control affects only semitransparent areas, it will have no effect on a matte’s hard edge.
Threshold
This range slider sets the lower threshold using the handle on the left and sets the upper threshold using the handle on the right.

Any value below the lower threshold setting becomes black or transparent in the matte.

Any value above the upper threshold setting becomes white or opaque in the matte. All values within the range maintain their relative transparency values.

This control is often used to reject salt and pepper noise in the matte.

Restore Fringe
This restores the edge of the matte around the keyed subject. Often when keying, the edge of the subject where you have hair is clipped out. Restore Fringe brings back that edge while keeping the matte solid.

Invert Matte
When this checkbox is selected, the alpha channel created by the keyer is inverted, causing all transparent areas to be opaque and all opaque areas to be transparent.

Solid Matte
Solid Mattes are mask nodes or images connected to the solid matte input on the node. The solid matte is applied directly to the alpha channel of the image. Generally, solid mattes are used to hold out keying in areas you want to remain opaque, such as someone with blue eyes against a blue screen.

Enabling Invert will invert the solid matte, before it is combined with the source alpha.

Garbage Matte
Garbage mattes are mask nodes or images connected to the garbage matte input on the node. The garbage matte is applied directly to the alpha channel of the image. Generally, garbage mattes are used to remove unwanted elements that cannot be keyed, such as microphones and booms. They are also used to fill in areas that contain the color being keyed but that you wish to maintain.

Garbage mattes of different modes cannot be mixed within a single tool. A Matte Control node is often used after a Keyer node to add a garbage matte with the opposite effect of the matte applied to the keyer.

Enabling Invert will invert the garbage matte, before it is combined with the source alpha.

Post-Multiply Image
Select this option to cause the keyer to multiply the color channels of the image against the alpha channel it creates for the image. This option is usually enabled and is on by default.

Deselect this checkbox and the image can no longer be considered premultiplied for purposes of merging it with other images. Use the Subtractive option of the Merge node instead of the Additive option.

For more information on these Merge node settings, see Chapter 35, “Composite Nodes” in the Fusion Reference Manual or Chapter 96 in the DaVinci Resolve Reference Manual.

Common Controls
Settings Tab
The Settings tab in the Inspector is also duplicated in other matte nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
Clean Plate

Clean Plate Node Introduction

The Clean Plate tool is a pre-keying node used to generate an image of the green or blue color screen to smooth out the lighting differences. The output of the Clean Plate is later connected to the Clean Plate input on the Delta Keyer so it can key fine detail without choking or clipping the matte.

How to Create a Clean Plate

Creating a clean plate is the opposite of creating a key. When keying, you try to remove the green or blue color. When creating a clean plate, you try to keep as much of the blue- or green-screen as possible. By box selecting areas of the screen color in the viewer, you end up with an image of the green/blue screen. A transparent cutout represents everything that is not part of the blue or green screen.

Once you have the selection, the Erode control expands the pre-matte, removing any small pixels of non-green/blue screen around the edges. Then, growing the pre-matte fills in the holes until you have a solid blue or green image.

Inputs

The Clean Plate node includes three inputs in the Node Editor.

- **Input**: The orange input accepts a 2D image that contains the green or blue screen.
- **Garbage Matte**: The white garbage matte input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input causes areas of the image that fall within the matte to be excluded from the clean plate. For a clean plate, garbage mattes should contain areas that are not part of the blue or green screen.
- **Effect Mask**: The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input limits the pixels where the clean plate is generated. An effects mask is applied to the tool after the tool is processed.
Basic Node Setup

The Clean Plate node and the Delta Keyer are two separate branches stemming from the main image you want to key. The green-screen or blue-screen clip is breached to connect to both the orange image input on the Clean Plate and the orange image input on the Delta Keyer. The output of the clean plate is then connected to the magenta clean plate input on the Delta Keyer. The output of the Delta Keyer is then used as the foreground to a Merge.

![A Clean Plate connected to a Delta Keyer](image)

Inspector

The Clean Plate tab

Plate Tab

The Plate tab contains the primary tools for creating a clean plate. Using this tab, you drag over the areas in the viewer, and then use the Erode and Grow Edges sliders to create the clean plate.

Method

The Method menu selects the type of color selection you use when sampling colors in the viewer.

- **Color**: Color uses a difference method to separate the background color. This works well on screen colors that are even.
- **Ranges**: Ranges uses a chroma range method to separate the background color. This is a better option for shadowed screen or screens that have different colors.
Matte Threshold
This range slider sets the lower threshold using the handle on the left and sets the upper threshold using the handle on the right.

Any value below the lower threshold becomes black or transparent in the matte.

Any value above the upper threshold becomes white or opaque in the matte. All values within the range maintain their relative transparency values. This control is often used to reject salt and pepper noise in the matte.

Erode
The Erode slider decreases the size of the screen area. It is used to eat away at small non-screen color pixels that may interfere with creating a smooth green- or blue-screen clean plate.

Crop
Crop trims in from the edges of the image.

Grow Edges
The Grow Edges slider expands the color of the edges to fill in holes until fully green or blue screen is created.

Fill
The Fill checkbox fills in remaining holes with color from the surrounding screen color.

Time Mode
– Sequence: Generates a new clean plate every frame.
– Hold Frame: Holds the clean plate at a single frame.

Mask Tab
The Mask tab is used to invert the mask connected to the garbage mask input on the node. The garbage mask can be applied to clear areas before growing edges or filling remaining holes.

Invert
Invert uses the transparent parts of the mask to clear the image.

Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other matte nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
**Delta Keyer**

The Delta Keyer node

**Delta Keyer Node Introduction**

The Delta Keyer is an advanced color difference keyer, with many features and controls for tuning the matte and separating the subject from a blue or green screen. It contains several keying systems: the Key tab is the master difference keyer and Pre-Matte is a built-in clean plate to smooth out screen color. Tuning, Fringe, and Matte finish the keying process. The tabs are laid out in the rough order you tend to use them.

**Inputs**

The Delta Keyer node includes five inputs in the Node Editor.

- **Input:** The orange input accepts a 2D image that contains the color you want to be keyed for transparency.
- **Garbage Matte:** The gray garbage matte input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input causes areas of the image that fall within the matte to be made transparent. The garbage matte is applied directly to the alpha channel of the image.
- **Solid Matte:** The white solid matte input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input causes areas of the image that fall within the matte to be fully opaque.
- **Clean Plate:** Accepts the resulting image from the Clean Plate node.
- **Effect Mask:** The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input limits the pixels where the keying occurs. An effects mask is applied to the tool after the tool is processed.

**Basic Node Setup**

A single Delta keyer rarely gets perfect results because most green- or blue-screen shots have problems that the keyer is not made to handle. Keyers often need the help of garbage mattes or solid mattes created with a Polygon or B-Spline node. Shots can also require more than just one keyer to achieve perfect results. That is shown in one of the examples below, where one Delta Keyer is used to create a hard inner white matte, while a second Delta Keyer is used to capture the soft edges. The core matte below is then connected into the solid matte input on the second Delta Keyer. Color correction, including spill suppression, is best handled as a separate branch in your node tree. Separating your matte from your color correction using underlays makes it clear what branch of nodes is performing what operation.
Starting point for a Delta Keyer setup

An expanded key setup with two Delta Keyers, a Polygon and B-Spline nodes for mattes, and a branch for color correction

Inspector

The Delta Keyer View Mode menu

Key Tab View Mode

At the top of the Inspector is the View Mode menu. The default selection shows the final result. You can change the view to see various intermediate stages of the keying process.

- **Pre Matte**: Displays the output of the Pre Matte key.
- **Matte**: Displays the alpha of the key before being combined with solid and garbage masks. When displaying the matte, set the viewer to show the alpha channel.
- **Tuning Ranges**: Displays a false color for Shadow, Midtone, and Highlight ranges of the image. Shadows are in the red channel, Midtones are in the green channel, and Highlights are in the blue channel.
– **Status:** Displays information to indicate areas that are solid, transparent, or in between. It also displays areas that have been affected by matte adjustments, such as thresholding or erode/dilate and areas affected by the solid mask.

– **Intermediate Result:** The untouched source image color channels combined with the final matte. Optionally, combine this output with additional Delta Keyer nodes.

– **Final Result:** The final keyed image with spill suppression, ready to merge onto a scene.

The Delta Keyer Key tab

The key tab is where most keying begins. It is used to select the screen color.

**Background Color**

This is the color of the blue or green screen, sometimes called the screen color. To create the key with the Delta Keyer, use the background color Eyedropper to select the screen color from the image.

**Pre-Blur**

Applies a blur before generating the alpha. This can help with certain types of noise, edge enhancements, and artifacts in the source image.

**Gain**

Gain increases the influence of the screen color, causing those areas to become more transparent.
Balance
A color difference keyer, like the Delta Keyer, compares the differences between the dominant channel determined by the selected background color and the other two channels. Adjusting balance determines the proportions of the other two channels. A value of 0 uses the minimum of the other two channels, where a value of 1 uses the maximum. A value of 0.5 uses half of each.

Lock Alpha/Spill Removal Color Balance Reference
Unlocking this allows you to use different color references when generating the alpha and when determining how much of the background color to subtract from the image. When enabled, spill and color are combined.

Color Balance Reference
The Color balance reference controls adjust for lighting or white balance that might be reducing background color purity and saturation. A correction is applied based on the reference of a neutral-colored object when generating the key and determining the amount of background color subtraction, without altering the background color that is subtracted.

Pre Matte Tab
The Pre Matte tab is in some ways a garbage matte keyer that occurs before the delta keyer process. It is used to even out the screen color before a more delicate key is done. After selecting the initial screen color, you can switch to the Pre Matte tab and view the PreMatte Out from view mode menu at the top of the Inspector. The Pre Matte works on ranges of color, so you start by dragging a bounding box around areas where lighting is different from the initial screen color pick. Use the Soft range to expand, and Erode to cut away the edges.

Once you have a more even screen selection, you can move to the Matte tab.

Soft Range
The Soft Range extends the range of selected color and rolloff of the screen color.

Erode
Erode contracts the edge of the pre matte, so the edge detail does not clip.
Blur
This softens the edges of the pre matte.

Pre Matte Range
These controls update automatically to represent the current color selection. The controls tweak the selection slightly, although selecting colors in the viewer is all that is required.

Lock Color Picking
When this checkbox is activated, it prevents the accidental growth of the selected range by selecting more colors from the view. It is a good idea to activate this checkbox after selecting the color for the matte. All other controls in the node remain editable.

Reset Pre Matte Ranges
This button discards all color selection by resetting the ranges but maintains all other slider and control values.

The Delta Keyer Matte tab

Matte Tab
The Matte tab refines the alpha of the key, combined with any solid and garbage masks connected to the node. When using the matte tab, set the viewer to display the alpha channel of the Delta Keyer’s final output.

Threshold
This range slider sets the lower threshold using the handle on the left and sets the upper threshold using the handle on the right.

Any value below the lower threshold setting becomes black or transparent in the matte.

Any value above the upper threshold setting becomes white or opaque in the matte. All values within the range maintain their relative transparency values.
**Restore Fringe**
This restores the edge of the matte around the keyed subject. Often when keying, clipping occurs around the edge of the subject where there is hair. Restore Fringe brings back that edge while keeping the matte solid.

**Erode/Dilate**
Expands or contracts the matte.

**Blur**
Softens the matte.

**Clean Foreground**
Fills slightly transparent (light gray) areas of the matte.

**Clean Background**
Clips the bottom dark range of the matte.

**Replace Mode**
Determines how matte adjustments restore color to the image.
- **None**: No color replacement. Matte processing does not affect the color.
- **Source**: The color from the original image.
- **Hard Color**: A solid color.
- **Soft Color**: A solid color weighted by how much background color was originally removed.

**Replace Color**
The color used with the Hard Color and Soft Color replace modes.

---

![The Delta Keyer Fringe tab](image)

**Fringe Tab**
The Fringe tab handles the majority of spill suppression in the Delta Keyer. Spill suppression is a form of color correction that attempts to remove the screen color from the fringe of the matte.

Spill is the transmission of the screen color through the semitransparent areas of the alpha channel. In the case of blue- or green-screen keying, this usually causes the color of the background to become apparent in the edges of the foreground subject.
Spill Method
This selects the strength of the algorithm used to apply spill suppression to the image.

- **None**: None is selected when no spill suppression is required.
- **Rare**: This removes very little of the spill color and is the lightest of all methods.
- **Medium**: This works best for green screens.
- **Well Done**: This works best for blue screens.
- **Burnt**: This works best for blue screens. Use this mode only for very troublesome shots.

Spill Suppression
When this slider is set to 0, no spill suppression is applied to the image. Increasing the slider increases the strength of the spill method.

Fringe Gamma
This control can be used to adjust the brightness of the fringe or halo that surrounds the keyed image.

Fringe Size
This expands and contracts the size of the fringe or halo surrounding the keyed image.

Fringe Shape
Fringe Shape presses the fringe toward the external edge of the image or pulls it toward the inner edge of the fringe. Its effect is most noticeable while the Fringe Size value is large.

Cyan/Red, Magenta/Green, and Yellow/Blue
Use these three controls to color correct the fringe of the image. This is useful for correcting semitransparent pixels that still contain color from the original background to match the new background.

The Delta Keyer Tuning tab

Tuning Tab
The Tuning tab is an advanced tab that allows you to determine the size of the shadow, midtone, and highlight ranges. By modifying the ranges, you can select the strength of the matte and spill suppression based on tonal values.
Range Controls
The range controls define how much color is considered to fall into the shadows, midtones, and highlights areas of the image. The spline controls allow for easy adjusting of the tonal ranges of each Shadow and Highlight tonal map.

Simple/Smooth
The Simple button sets the range to be linear. The Smooth button sets a smooth tonal gradient for the ranges.

Lock Alpha/Spill Removal Tuning
When this checkbox is disabled, separate tuning controls are used when generating the alpha and when determining how much of the background color to subtract from the image.

- **Shadows**: Adjusts the strength of the key in darker areas of the background.
- **Midtones**: Adjusts the strength of the key in midtone areas of the background.
- **Highlights**: Adjusts the strength of the key in brighter areas of the background.

Mask Tab
The Mask tab determines how the solid and garbage mattes are applied to the key.

Solid Source Alpha
Used to combine the existing alpha from the source image with the solid mask.

- **Ignore**: Does not combine the alpha from the source image.
- **Add**: Solid areas of the source image alpha are made solid in the solid mask.
- **Subtract**: Transparent areas of the source image alpha are made transparent in the solid mask.
**Solid Replace Mode**
This determines how the solid mask restores color to the image.

- **None**: No color replacement. The solid mask does not affect the color.
- **Source**: The color from the original image.
- **Hard Color**: A solid color.
- **Soft Color**: A solid color weighted by how much background color was originally removed.

**Solid Replace Color**
The color used with the Hard Color and Soft Color replace modes.

- **Invert**: Inverts the solid mask, before it is combined with the source alpha.

**Garbage Mask**

- **Invert**: Normally, solid areas of a garbage mask remove the image. When inverted, the transparent areas of the mask remove the image.

**Common Controls**

**Settings Tab**
The Settings tab in the Inspector is also duplicated in other matte nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

### Difference Keyer [DfK]

The Difference Keyer node

**Difference Keyer Node Introduction**

Difference keying is a process that produces a matte based on the differences between two images. A difference key uses two input images: one containing the subject with the background and another containing the background without the subject.

Although the process sounds reasonable at first glance, subtle variations in the camera position from shot to shot usually make it difficult to get clean results. Think of the futile attempt of trying to key smoke in front of a brick wall and using a clean plate of the brick wall as your difference input. Part of the wall’s structure is always visible in this keying method. Instead, a Difference Keyer is often used to produce a rough matte that is combined with other nodes to produce a more detailed matte.

**Inputs**
The Difference Keyer node includes four inputs in the Node Editor.

- **Background**: The orange background input accepts a 2D image that contains just the set without your subject.
- **Foreground**: The green foreground input accepts a 2D image that contains the shot with your subject in the frame.
– **Garbage Matte:** The gray garbage matte input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input causes areas of the image that fall within the matte to be made transparent.

– **Solid Matte:** The white solid matte input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input causes areas of the image that fall within the matte to be fully opaque.

– **Effect Mask:** The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input limits the pixels where the difference matte occurs. An effects mask is applied to the tool after the tool is processed.

**Basic Node Setup**

When you do not have content shot on a blue or green screen, the Difference Keyer can be one node in a chain of many used to extract an object from the background. The example below has the MediaIn1 as the main subject and a clean background shot without the subject (Background). A B-Spline is used to limit the area the Difference Keyer must deal with for extraction. The result is a matte that can be used to help but not solve the key.

![A Difference Keyer with two inputs: one of the subject on a background and the other of just the background](image)

**Inspector**

![The Difference Keyer Controls tab](image)
Controls Tab
The Controls tab in the Difference Keyer contains all the parameters for adjusting the quality of the matte.

Threshold
This range slider sets the lower threshold using the handle on the left and sets the upper threshold using the handle on the right. Adjusting them defines a range of difference values between the images to create a matte.

A difference below the lower threshold setting becomes black or transparent in the matte.

Any difference above the upper threshold setting becomes white or opaque in the matte.

The difference values in the range in between create a grayscale matte.

Filter
This control selects the filtering algorithm used when applying a blur to the matte.

- **Box**: This is the fastest method but at reduced quality. Box is best suited for minimal amounts of blur.

- **Bartlett**: Otherwise known as a Pyramid filter, Bartlett makes a good compromise between speed and quality.

- **Multi-box**: When selecting this filter, the Num Passes slider appears and lets you control the quality. At 1 and 2 passes, results are identical to Box and Bartlett, respectively. At 4 passes and above, results are usually as good as Gaussian. In less time and with no edge “ringing.”

- **Gaussian**: The Gaussian filter uses a true Gaussian approximation and gives excellent results, but it is a little slower than the other filters. In some cases, it can produce an extremely slight edge “ringing” on floating-point pixels.

Blur
This blurs the edge of the matte using the method selected in the Filter menu. A value of zero results in a sharp, cutout-like hard edge. The higher the value, the more blur.

Clipping Mode
This option determines how edges are handled when performing domain of definition rendering. This is profoundly important when blurring the matte, which may require samples from portions of the image outside the current domain.

- **Frame**: The default option is Frame, which automatically sets the node’s domain of definition to use the full frame of the image, effectively ignoring the current domain of definition. If the upstream DoD is smaller than the frame, the remaining area in the frame is treated as black/transparent.

- **Domain**: Setting this option to Domain respects the upstream domain of definition when applying the node’s effect. This can have adverse clipping effects in situations where the node employs a large filter.

- **None**: Setting this option to None does not perform any source image clipping at all. This means that any data required to process the node’s effect that would usually be outside the upstream DoD is treated as black/transparent.
Contract/Expand
This slider shrinks or grows the semitransparent areas of the matte. Values above 0.0 expand the matte, while values below 0.0 contract it.

This control is usually used in conjunction with the blur to take the hard edge of a matte and reduce fringing. Since this control affects only semitransparent areas, it has no effect on a matte’s hard edge.

Gamma
Matte Gamma raises or lowers the values of the matte in the semitransparent areas. Higher values cause the gray areas to be more opaque, and lower values cause the gray areas to be more transparent. Wholly black or white regions of the matte remain unaffected.

Invert
Selecting this checkbox inverts the matte, causing all transparent areas to be opaque and all opaque areas to be transparent.

Solid Matte
Solid Mattes are mask nodes or images connected to the solid matte input on the node. The solid matte is applied directly to the alpha channel of the image. Generally, solid mattes are used to hold out keying in areas you want to remain opaque, such as someone with blue eyes against a blue screen.

Enabling Invert, inverts the solid matte before it is combined with the source alpha.

Garbage Matte
Garbage mattes are mask nodes or images connected to the garbage matte input on the node. The garbage matte is applied directly to the alpha channel of the image. Generally, garbage mattes are used to remove unwanted elements that cannot be keyed, such as microphones and booms. They are also used to fill in areas that contain the color being keyed but that you wish to maintain.

Garbage mattes of different modes cannot be mixed within a single tool. A Matte Control node is often used after a Keyer node to add a garbage matte with the opposite effect of the matte applied to the keyer.

Enabling Invert inverts the garbage matte before it is combined with the source alpha.

Post-Multiply Image
Select this option to cause the keyer to multiply the color channels of the image against the alpha channel it creates for the image. This option is usually enabled and is on by default.

Deselect this checkbox, and the image can no longer be considered premultiplied for purposes of merging it with other images. Use the Subtractive option of the Merge node instead of the Additive option.

For more information on these Merge node settings, see Chapter 35, “Composite Nodes” in the Fusion Reference Manual or Chapter 96 in the DaVinci Resolve Reference Manual.

Common Controls
Settings Tab
The Settings tab in the Inspector is also duplicated in other Matte nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
Luma Keyer [LKY]

Luma Keyer Node Introduction

The Luma Keyer node uses the overall luminance of an image to create an Alpha channel. The label of this node may seem misleading since it allows pulling mattes from almost any channel. In some respects, it is more accurate to call this node an all-purpose channel keyer, but its primary purpose is for extracting alpha channels based on luminance.

Inputs

The Luma Keyer node includes four inputs in the Node Editor.

- **Input:** The orange input accepts a 2D image that contains the luminance values you want to be keyed for transparency.

- **Garbage Matte:** The gray garbage matte input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input causes areas of the image that fall within the matte to be made transparent. The garbage matte is applied directly to the alpha channel of the image.

- **Solid Matte:** The white solid matte input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input causes areas of the image that fall within the matte to be fully opaque.

- **Effect Mask:** The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input limits the pixels where the luminance key occurs. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

The Luma Keyer takes an input from an image with significant luminance difference to extract a key. You can then use the output of the Luma Keyer into any mask input.
Inspector

The Controls tab in the Luma Keyer contains all the parameters for adjusting the quality of the matte.

Channel
This menu selects the color channel used for creating the matte. Select from the Red, Green, Blue, Alpha, Hue, Luminance, Saturation, and Depth (Z-buffer) channels.

Threshold
This range slider sets the lower threshold using the handle on the left and sets the upper threshold using the handle on the right. Adjusting them defines a range of luminance values to create a matte. A value below the lower threshold setting becomes black or transparent in the matte. Any value above the upper threshold setting becomes white or opaque in the matte. The values within the range create a grayscale matte.

Filter
This control selects the filtering algorithm used when applying a blur to the matte.

- **Box**: This is the fastest method but at reduced quality. Box is best suited for minimal amounts of blur.
- **Bartlett**: Otherwise known as a Pyramid filter, Bartlett makes a good compromise between speed and quality.
- **Multi-box**: When selecting this filter, the Num Passes slider appears and lets you control the quality. At 1 and 2 passes, results are identical to Box and Bartlett, respectively. At 4 passes and above, results are usually as good as Gaussian, in less time and with no edge “ringing.”
- **Gaussian**: The Gaussian filter uses a true Gaussian approximation and gives excellent results, but it is a little slower than the other filters. In some cases, it can produce an extremely slight edge “ringing” on floating-point pixels.
Blur
This blurs the edge of the matte using the method selected in the Filter menu. A value of zero results in a sharp, cutout-like hard edge. The higher the value, the more blur.

Clipping Mode
This option determines how edges are handled when performing domain of definition rendering. This is profoundly important when blurring the matte, which may require samples from portions of the image outside the current domain.

- **Frame**: The default option is Frame, which automatically sets the node's domain of definition to use the full frame of the image, effectively ignoring the current domain of definition. If the upstream DoD is smaller than the frame, the remaining area in the frame is treated as black/transparent.

- **Domain**: Setting this option to Domain respects the upstream domain of definition when applying the node's effect. This can have adverse clipping effects in situations where the node employs a large filter.

- **None**: Setting this option to None does not perform any source image clipping at all. This means that any data required to process the node's effect that is usually outside the upstream DoD is treated as black/transparent.

Contract/Expand
This slider shrinks or grows the semitransparent areas of the matte. Values above 0.0 expand the matte, while values below 0.0 contract it.

This control is usually used in conjunction with the blur to take the hard edge of a matte and reduce fringing. Since this control affects only semitransparent areas, it has no effect on a matte's hard edge.

Gamma
Matte Gamma raises or lowers the values of the matte in the semitransparent areas. Higher values cause the gray areas to be more opaque, and lower values cause the gray areas to be more transparent. Wholly black or white regions of the matte remain unaffected.

Invert
Selecting this checkbox inverts the matte, causing all transparent areas to be opaque and all opaque areas to be transparent.

Solid Matte
Solid mattes are mask nodes or images connected to the solid matte input on the node. The solid matte is applied directly to the alpha channel of the image. Generally, solid mattes are used to hold out keying in areas you want to remain opaque, such as someone with blue eyes against a blue screen.

Enabling Invert inverts the solid matte before it is combined with the source alpha.

Garbage Matte
Garbage mattes are mask nodes or images connected to the garbage matte input on the node. The garbage matte is applied directly to the alpha channel of the image. Generally, garbage mattes are used to remove unwanted elements that cannot be keyed, such as microphones and booms. They are also used to fill in areas that contain the color being keyed but that you wish to maintain.

Garbage mattes of different modes cannot be mixed within a single tool. A Matte Control node is often used after a Keyer node to add a garbage matte with the opposite effect of the matte applied to the keyer.

Enabling Invert inverts the garbage matte before it is combined with the source alpha.
Post-Multiply Image
Select this option to cause the keyer to multiply the color channels of the image against the alpha channel it creates for the image. This option is usually enabled and is on by default.

Deselect this checkbox and the image can no longer be considered premultiplied for purposes of merging it with other images. Use the Subtractive option of the Merge node instead of the Additive option.

For more information on these Merge node settings, see Chapter 35, “Composite Nodes” in the Fusion Reference Manual or Chapter 96 in the DaVinci Resolve Reference Manual.

Common Controls
Settings Tab
The Settings tab in the Inspector is also duplicated in other Matte nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Matte Control [MAT]

Matte Control Node Introduction
Keyer nodes are used to create an alpha channel on an image that does not have one. The Matte Control node is used to combine and manipulate the alpha channels embedded in images as well as masks created by masking tools.

Typically, you add this node to copy a color channel or alpha channel from the foreground input to the background input, or to combine alpha channels from the two images.

Inputs
The Matte Control node includes four inputs in the Node Editor.

- **Background**: The orange background input accepts a 2D image that receives the foreground image alpha channel (or some other channel you want to copy to the background).
- **Foreground**: The green foreground input accepts a 2D image that contains an alpha channel (or some other channel) you want to be applied to the background image.
- **Garbage Matte**: The gray garbage matte input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input causes areas of the foreground/background combination that fall within the matte to be made transparent.
- **Solid Matte**: The white solid matte input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input causes areas of the foreground/background combination that fall within the matte to be fully opaque.
- **Effect Mask**: The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input limits the pixels where the matte control occurs. An effects mask is applied to the tool after the tool is processed.
Basic Node Setup

Below, the Matte Control node is set up to copy the foreground (green) input’s alpha channel into the background (orange) input. The output of the Matte Control is then an image with an alpha channel used as the foreground composite in the Merge node.

A Matte Control embedded an alpha from the foreground input to the background input

Inspector

The Matte Control Matte tab

Matte Tab

The Matte tab combines and modifies alpha or color channels from an image in the foreground input with the background image.

Combine

Use this menu to select which operation is applied. The default is set to None for no operation.

- **None**: This causes the foreground image to be ignored.
- **Combine Red**: This combines the foreground red channel to the background alpha channel.
- **Combine Green**: This combines the foreground green channel to the background alpha channel.
- **Combine Blue**: This combines the foreground blue channel with the background alpha channel.
- **Combine Alpha**: This combines the foreground alpha channel with the background alpha channel.
- **Solid**: This causes the background alpha channel to become completely opaque.
- **Clear**: This causes the background alpha channel to become completely transparent.

### Combine Operation

Use this menu to select the method used to combine the foreground channel with the background.
- **Copy**: This copies the foreground source over the background alpha, overwriting any existing alpha in the background.
- **Add**: This adds the foreground source to the background alpha.
- **Subtract**: This subtracts the foreground source from the background alpha.
- **Inverse Subtract**: This subtracts the background alpha from the foreground source.
- **Maximum**: This compares the foreground source and the background alpha and takes the value from the pixel with the highest value.
- **Minimum**: This compares the foreground source and the background alpha and takes the value from the pixel with the lowest value.
- **And**: This performs a logical AND on the two values.
- **Or**: This performs a logical OR on the values.
- **Merge Over**: This merges the foreground source channel over the background alpha channel.
- **Merge Under**: This merges the foreground source channel under the background alpha channel.

### Filter

Selects the Filter that is used when blurring the matte.
- **Box Blur**: This option applies a Box Blur effect to the whole image. This method is faster than the Gaussian blur but produces a lower-quality result.
- **Bartlett**: Bartlett applies a more subtle, anti-aliased blur filter.
- **Multi-Box**: Multi-Box uses a box filter layered in multiple passes to approximate a Gaussian shape. With a moderate number of passes (e.g., four), a high-quality blur can be obtained, often faster than the Gaussian filter and without any ringing.
- **Gaussian**: Gaussian applies a smooth, symmetrical blur filter, using a sophisticated constant-time Gaussian approximation algorithm. In extreme cases, this algorithm may exhibit ringing; see below for a discussion of this. This mode is the default filter method.

### Blur

This blurs the edge of the matte using a standard, constant speed Gaussian blur. A value of zero results in a sharp, cutout-like hard edge. The higher the value, the more blur is applied to the matte.

### Clipping Mode

This option determines how edges are handled when performing domain of definition rendering. This is profoundly important when blurring the matte, which may require samples from portions of the image outside the current domain.
- **Frame**: The default option is Frame, which automatically sets the node’s domain of definition to use the full frame of the image, effectively ignoring the current domain of definition. If the upstream DoD is smaller than the frame, the remaining area in the frame is treated as black/transparent.
– **Domain**: Setting this option to Domain respects the upstream domain of definition when applying the node’s effect. This can have adverse clipping effects in situations where the node employs a large filter.

– **None**: Setting this option to None does not perform any source image clipping at all. This means that any data required to process the node’s effect that is usually outside the upstream DoD is treated as black/transparent.

**Contract/Expand**
This shrinks or grows the matte similar to an Erode Dilate node. Contracting the matte reveals more of the foreground input, while expanding the matte reveals more of the background input. Values above 0.0 expand the matte, and values below 0.0 contract it.

**Gamma**
This raises or lowers the values of the matte in the semitransparent areas. Higher values cause the gray areas to become more opaque, and lower values cause the gray areas to become more transparent. Completely black or white regions of the matte remain unaffected.

**Threshold**
Any value below the lower threshold becomes black or transparent in the matte. Any value above the upper threshold becomes white or opaque in the matte. All values within the range maintain their relative transparency values.

**Restore Fringe**
This restores the edge of the matte around the keyed subject. Often when keying, the edge of the subject where you have hair is clipped out. Restore Fringe brings back that edge while keeping the matte solid.

**Invert Matte**
When this checkbox is selected, the alpha channel of the image is inverted, causing all transparent areas to be opaque and all opaque areas to be transparent.

**Solid Matte**
Solid mattes are mask nodes or images connected to the solid matte input on the node. The solid matte is applied directly to the alpha channel of the image. Generally, solid mattes are used to hold out areas you want to remain opaque, such as someone with blue eyes against a blue screen.

Enabling Invert inverts the solid matte before it is combined with the source alpha.

**Garbage Matte**
Garbage mattes are mask nodes or images connected to the garbage matte input on the node. The garbage matte is applied directly to the alpha channel of the image. Generally, garbage mattes are used to remove unwanted elements that cannot be keyed, such as microphones and booms. They are also used to fill in areas that contain the color being keyed but that you wish to maintain.

Garbage mattes of different modes cannot be mixed within a single tool. A Matte Control node is often used after a Keyer node to add a garbage matte with the opposite effect of the matte applied to the keyer.

Enabling Invert inverts the garbage matte before it is combined with the source alpha.

**Post-Multiply Image**
Selecting this option multiplies the color channels of the image against the alpha channel it creates for the image. This option is usually enabled and is on by default.

Deselect this checkbox and the image can no longer be considered premultiplied for purposes of merging it with other images. Use the Subtractive option of the Merge node instead of the Additive option.
For more information on these Merge node settings, see Chapter 35, “Composite Nodes” in the Fusion Reference Manual or Chapter 96 in the DaVinci Resolve Reference Manual.

The Matte Control Spill tab

Spill Tab
The Spill tab handles spill suppression in the Matte Control. Spill suppression is a form of color correction that attempts to remove the screen color from the fringe of the matte.

Spill is the transmission of the screen color through the semitransparent areas of the alpha channel. In the case of blue- or green-screen keying, this usually causes the color of the background to become apparent in the edges of the foreground subject.

Spill Color
This menu selects the color used as the base for all spill suppression techniques.

Spill Suppression
When this slider is set to 0, no spill suppression is applied to the image. Increasing the slider increases the strength of the spill method.

Spill Method
This selects the strength of the algorithm used to apply spill suppression to the image.

- **None**: None is selected when no spill suppression is required.
- **Rare**: This removes very little of the spill color and is the lightest of all methods.
- **Medium**: This works best for green screens.
- **Well Done**: This works best for blue screens.
- **Burnt**: This works best for blue screen. Use this mode only for very troublesome shots.

Fringe Gamma
This control can be used to adjust the brightness of the fringe or halo that surrounds the keyed image.

Fringe Size
This expands and contracts the size of the fringe or halo surrounding the keyed image.

Fringe Shape
Fringe Shape presses the fringe toward the external edge of the image or pulls it toward the inner edge of the fringe. Its effect is most noticeable while the Fringe Size value is large.
Cyan/Red, Magenta/Green, and Yellow/Blue

Use these three controls to color correct the fringe of the image.
This is useful for correcting semitransparent pixels that still contain color from the original background to match the new background.

Common Controls

Settings Tab

The Settings tab in the Inspector is also duplicated in other Matte nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Primatte [Pri]

The Primatte node

NOTE: Primatte is only available in Fusion Studio.

Primatte Node Introduction

Primatte is an advanced keying tool for Fusion Studio. To use Primatte effectively, you must understand how it works. Using a series of selection buttons, Primatte assigns RGB pixels into one of the four specific zones.

– Zone 1: Complete background image.
– Zone 2: Foreground image with spill suppression and transparency.
– Zone 3: Foreground image with spill suppression only.
– Zone 4: Complete foreground image.

Depending on the type of blue- or green-screen content, you may find that the Delta Keyer or the Primatte keyer handles the specific keying task better. There is no one-solution-fits-all when it comes to keying, and in some cases, the combination of the two keyers may prove to be the best solution.

NOTE: Primatte is distributed and licensed by IMAGICA Corp. of America, Los Angeles, CA, USA. Primatte was developed by and is a trademark of IMAGICA Corp., Tokyo, Japan.

Inputs

The Primatte node includes six inputs in the Node Editor. Unlike every other tool in Fusion, the primary orange input is labeled as the Foreground input, since it accepts the green-screen or blue-screen image. The background input on the Primatte node is the green input; this is an optional input that allows Primatte to create the final merged composite.
– **Foreground Input:** The orange input accepts a 2D image that contains blue or green screen.

– **Background Input:** The green (optional) input accepts a 2D image layered as the background in the composite. If no image is connected, Primatte outputs the keyed foreground. Connecting an image to the background input activates Primatte’s advanced edge blending options.

– **Replacement Image:** The magenta (optional) input accepts a 2D image used as a source of Primatte’s spill suppression color correction.

– **Garbage Matte:** The gray garbage matte input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input causes areas of the image that fall within the matte to be made transparent. The garbage matte is applied directly to the alpha channel of the image.

– **Solid Matte:** The white solid matte input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input causes areas of the image that fall within the matte to be fully opaque.

– **Effect Mask:** The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input limits the pixels where the keying occurs. An effects mask is applied to the tool after the tool is processed.

**NOTE:** Connecting the background input without connecting the replacement image input uses the background image as the replacement image surf spill suppression.

**Basic Node Setup**

A single Primatte keyer can rarely get perfect results because most green- or blue-screen shots have problems the keyer is not made to handle. Keyers often need the help of garbage mattes or solid mattes created with a Polygon or B-Spline node. Shots can also require more than just one keyer to achieve perfect results. Below, the Primatte node has the blue-screen content connected to the orange input. Unlike other Fusion nodes, the foreground gets connected to the orange input. The result is an image with alpha that can then be connected into the foreground of a Merge node.

A Primatte node combined with a polygon matte as a garbage matte and connected to the foreground of a Merge
Primatte Tab View Mode

At the top of the Inspector is the View Mode menu. The default selection shows the final Composite result. You can change the view to see various intermediate stages of the keying process.

- **Black**: Displays the foreground subject on a black or transparent background.
- **Composite**: The final keyed image with spill suppression, composited over the image connected to the green Background Input on the node.
- **Defocus Foreground**: Displays the output of the Pre Matte key.
- **Processed Foreground**: Displays the alpha of the key before being combined with solid and garbage masks. When displaying the matte, set the viewer to show the alpha channel.
- **Hybrid Matte**: Displays the matte generated when the Hybrid Rendering checkbox is enabled. Best viewed when adjusting the Hybrid Blur and Hybrid Erode sliders.
- **Lighting Foreground**: Displays the foreground subject over the optimized artificial backing screen that the Adjust Lighting mode creates.
- **Lighting Background**: Displays the optimized artificial backing screen that the Adjust Lighting mode creates.
Primatte Tab

The core functionality for Primatte is found in the Primatte tab. The basic workflow is based on selecting one of the operational mode buttons and then scrubbing over areas in the viewer.

Lock Color Picking

Activate this button once you finished adjusting your key to prevent making accidental changes in the viewer.

Auto Compute

The Auto Compute button is likely the first button pressed when starting to key your footage. Primatte automagically analyzes the original foreground image, determines the backing color, and sets it as the central backing color. Then, using that information, another analysis determines the foreground areas. A Clean FG Noise operation is performed using the newly determined foreground areas, and Primatte renders the composite.

**NOTE:** The Auto Compute button may make the next three buttons—Select Background Color, Clean Background Noise, and Clean Foreground Noise—unnecessary and make your keying operation much more straightforward. Clicking Auto Compute automatically senses the backing screen color, eliminates it, and even gets rid of some foreground and background noise. If you get good results, then jump ahead to the Spill Removal tools. If you don’t get satisfactory results, continue from this point using the three buttons described below.

Select Background Color

Clicking the Select Background Color button allows you to select the screen color by scrubbing in the viewer. It uses the traditional Primatte method of taking the sampled backing screen color, projecting a line in the opposite direction on the hue wheel, and generating artificial pixels that may represent the FG object. Then, using the artificially generated foreground pixels, it internally does the Clean FG Noise operation and creates the shape of the middle and outer polyhedrons. It then renders the composite using these generated polyhedrons. This does not automatically use the Adjust Lighting functionality, as it must be selected in a separate operation.

Clean Background Noise

Clicking this button helps to remove any white regions in the dark screen area ("noise"), or shades of the screen color that did not get picked up on the first sample. Once you click the button, scrub the mouse pointer over areas in the viewer to sample white-ish noise regions.

Clean Foreground Noise

If there are dark transparent regions in the middle of the mostly white opaque foreground object, click the Clean Foreground Noise button and scrub over the dark pixels in the foreground area until that area is as white as possible.

Spill Sponge

The Spill Sponge is the quickest method for removing color spill on your subject. Click the Spill Sponge button and scrub the mouse pointer over a screen color pixel, and the screen color disappears from the selected color region and is replaced by a complementary color, a selected color, or a color from a replacement image. These options are set in the Replace tab. Additionally, use the tools under the Fine Tuning tab or use the Spill(+) and Split(-) features to adjust the spill.
Matte Sponge
Sometimes in the Primatte operation, a 100% opaque, foreground area (all white) becomes slightly transparent (gray). To clean those transparent areas, click the Matte Sponge button and scrub over the transparent pixels. All the spill-suppression information remains intact.

Restore Detail
Clicking Restore Detail and scrubbing over background regions in the viewer turns completely transparent areas translucent. This operation is useful for restoring lost hair details, thin wisps of smoke, and the like.

Make Foreground Transparent
When this button is selected, the opaque foreground color region sampled in the viewer becomes slightly translucent. This operation is useful for the subtle tuning of foreground subjects, which are otherwise 100 percent covered with smoke or clouds. It can be used only one time on a particular color. For a more flexible way to thin out a color region, and to be able to take multiple samples, use the Matte(-) tool.

Spill(+)
Clicking the Spill(+) button returns the color spill to the sampled pixel color (and all colors like it) in the amount of one Primatte increment. This tool can be used to move the sampled color more in the direction of the color in the original foreground image. It can be used to nullify a Spill(-) step.

Spill(-)
Clicking the Spill(-) button removes from the sampled pixel color (and all colors like it) in the amount of one Primatte increment. If spill color remains, another click using this operational mode tool removes more of the color spill. Continue using this tool until all color spill has been removed from the sampled color region.

Matte(+)
Clicking the Matte(+) button makes the matte more opaque for the sampled pixel color (and all colors like it) in the amount of one Primatte increment. If the matte is still too translucent or thin, another click using this operational mode tool makes the sampled color region even more opaque. This can be used to thicken smoke or make a shadow darker to match shadows in the background imagery. It can only make these adjustments to the density of the color region on the original foreground image. It can be used to nullify a Matte(-) step.

Matte(-)
Clicking the Matte(+) button makes the matte more translucent for the sampled pixel color (and all colors like it) in the amount of one Primatte increment. If the matte is still too opaque, another click using this operational mode tool makes the sampled color region even more translucent. This can be used to thin out smoke or make a shadow thinner to match shadows in the background imagery.

Detail(+)
When this button is selected, the foreground detail becomes less visible for the sampled pixel color (and all colors like it) in the amount of one Primatte increment. If there is still too much detail, another click using this operational mode tool makes more of it disappear. This can be used to remove smoke or wisps of hair from the composite. Sample where detail is visible, and it disappears. This is for moving color regions into the 100% background region. It can be used to nullify a Detail(-) step.
Detail()

When this button is selected, foreground detail becomes more visible for the sampled pixel color (and all colors like it) in the amount of one Primatte increment. If detail is still missing, another click using this operational mode tool makes detail more visible. This can be used to restore lost smoke or wisps of hair. Sample where the smoke or hair just disappears and it returns to visibility. Use this for restoring color regions that were moved into the 100% background region. It may start to bring in background noise if shooting conditions were not ideal on the foreground image.

Algorithms

There are three keying algorithms available in the Primatte keyer:

- **Primatte**: The Primatte algorithm mode delivers the best results and supports both the Solid Color and the Complement Color spill suppression methods. This algorithm uses three multifaceted polyhedrons (as described later in this section) to separate the 3D RGB colorspace. It is also the default algorithm mode and, because it is computationally intensive, it may take the longest to render.

- **Primatte RT**: Primatte RT is the simplest algorithm and therefore the fastest. It uses only a single planar surface to separate the 3D RGB colorspace (as described later in this section) and, as a result, does not separate the foreground from the backing screen as carefully as the above Primatte algorithm. Another disadvantage of the Primatte RT algorithm is that it does not work well with less saturated backing screen colors, and it does not support the Complement Color spill suppression method.

- **Primatte RT+**: Primatte RT+ is in between the above two options. It uses a six planar surface color separation algorithm (as described later in this section) and delivers results in between the other two options in both quality and performance. Another disadvantage of the Primatte RT+ algorithm is that it does not work well with less saturated backing screen colors, and it does not support the Complement Color spill suppression method.

Hybrid Rendering

After sampling the backing screen color and producing acceptable edges around the foreground object, you sometimes find a transparent area within the foreground subject. This can occur when the foreground subject contains a color that is close to the backing screen color. Removing this transparency with the Clean FG Noise mode can cause the edge of the foreground subject to pick up a fringe that is close to the backing screen color. Removing the fringe is very difficult without sacrificing quality somewhere else on the image. The Hybrid Render mode internally creates two keying operations: Body and Edge. The optimized Edge operation gets the best edge around the foreground subject without any fringe effect. The Body operation deals with transparency within the foreground subject. The resultant matte is created by combining these two mattes, and then blurring and eroding the foreground subject in the Body matte and combining it with the edge matte.

To use Hybrid Rendering, start by keying the main foreground area using the Select Background Color mode (or any of the other Primatte backing screen detection methods). Activate the Hybrid Rendering checkbox. Lastly, select the Clean FG Noise button and scrub over the transparent area. The Hybrid Render mode performs the “Body/Edge” operation. The result is a final composite with perfect edges around the foreground subject with a solid foreground subject.

**Hybrid Blur**

Blurs the Body matte that has been automatically generated when Hybrid Rendering is activated.

**Hybrid Erode**

This slider dilates or erodes the Hybrid matte. You can view the results by selecting Hybrid matte in the View Mode menu.
Adjust Lighting
Before applying the Adjust Lighting operation, it is necessary to determine the backing screen color using Auto Compute or Select Background Color. After performing one of those operations, click on the Adjust Lighting button. Primatte generates an artificial clean plate and uses it to generate an evenly lit backing screen behind the foreground object. The default setting should detect all the areas that contain foreground pixels and deliver a smooth backing screen for the keying.

Lighting Threshold
Should Adjust Lighting fail to produce a smoother backing screen, adjust the Lighting Threshold slider while viewing the Lighting Background setting in the View Mode menu. This displays the optimized artificial backing screen that the Adjust Lighting mode creates.

Crop
This button reveals the Crop sliders to create a rectangular garbage matte with the Primatte node. As opposed to Fusion’s Crop tool, this does not change the actual image size.

Reset
Resets all the Primatte key control data back to a blue- or green-screen.

Soft Reset
Resets just the Primatte parameters used since the Select Background Color operation was last completed.

Fine Tuning Tab
The Fine Tuning tab can make refined adjustments to the spill suppression, density of the matte, and semitransparent areas. These sliders provide a bit more granularity over the Spill(+)(-), Matte(+)(-) and Detail(+)(-) buttons in the Primatte tab.

Selected Color
This shows the color selected (or registered) by the scrubbing in the viewer while the Fine Tuning tab is selected.
**Fine Tuning Sliders**

The color of the scrubbed pixel is registered as a reference color for fine tuning. It is displayed in the Color swatch. To perform the tuning operation, sample a color region on the image, and adjust one of the Fine Tuning sliders to achieve the desired effect.

**Spill**

The Spill slider can be used to remove spill from the selected color region. The more to the right the slider moves, the more spill is removed. The more to the left the slider moves, the closer the color component of the selected region is to the color in the original foreground image. If moving the slider to the right does not remove the spill, resample the color region and move the slider again.

These slider operations are additive. The result achieved by moving the slider to the right can also be achieved by clicking on the color region using the Spill(-) operational mode.

**Transparency**

The Transparency slider makes the matte more translucent in the selected color region. Moving this slider to the right makes the selected color region more transparent. Moving the slider to the left makes the matte more opaque. If moving the slider to the right does not make the color region translucent enough, resample the color region and again move the slider to the right. These slider operations are additive. The result achieved by moving the slider to the right can also be achieved by clicking on the color region using the Matte(-) operational mode.

**Detail**

The Detail slider can be used to restore lost detail. After selecting a color region, moving this slider to the left makes the selected color region more visible. Moving the slider to the right makes the color region less visible. If moving the slider to the left does not make the color region visible enough, resample the color region and again move the slider to the left.

These slider operations are additive. This result achieved by moving the slider to the left can also be achieved by clicking on the color region using the Detail(-) operational mode.

**Replace Tab**

The Replace tab allows you to choose between the three methods of color spill replacement as covered in detail in the Spill Sponge section above. There are three options for the replacement color when removing the spill. These options are selected from the Replace mode menu.

**Replace Mode**

- **Complement**: Replaces the spill color with the complement of the screen color. This mode maintains fine foreground detail and delivers the best-quality results. If foreground spill is not a significant problem, this mode is the one that should be used. However, if the spill intensity on the foreground image is rather significant, this mode may often introduce serious noise in the resultant composite.

- **Image**: Replaces the spill color with colors from a defocused version of the background image or the Replace image, if one is connected to the Replace input (magenta) on the node. This mode results in a good color tone on the foreground subject even with a high-contrast background. On the negative side, the Image mode occasionally loses the fine edge detail of the foreground.
subjects. Another problem can occur if you later change the size of the foreground image against the background. Since the background/foreground alignment would change, the applied color tone from the defocused image might not match the new alignment.

- **Color**: Replaces the spill color with a solid color. When this option is selected, a color swatch and R,G,B sliders are displayed for selecting the color. Changing the palette color for the solid replacement, you can select a good spill replacement that matches the composite background. Its strength is that it works fine with even severe spill conditions. On the negative side, when using the Solid Color Replacement mode, fine detail on the foreground edge tends to be lost. The single palette color sometimes cannot make a good color tone if the background image has some high-contrast color areas.

The Primatte Degrain tab

**Degrain Tab**

The Degrain tab is used when a foreground image is highly compromised by film grain. As a result of the grain, when backing screen noise is completely removed, the edges of the foreground object often become harsh and jagged, leading to a poor key.

**Grain Size**

The Grain Size selector provides a range of grain removal from Small to Large. If the foreground image has a large amount of film grain-induced pixel noise, you may lose a good edge to the foreground object when trying to clean all the grain noise with the Clean Background Noise Operation Mode. These tools clean up the grain noise without affecting the quality of the key.

- **None**: No degraining is performed.
- **Small**: The average color of a small region of the area around the sampled pixel. This should be used when the grain is very dense.
- **Medium**: The average color of a medium-sized region of the area around the sampled pixel. This should be used when the grain is less dense.
- **Large**: The average color of a larger region of the area around the sampled pixel. This should be used when the grain is very loose.

**Grain Tolerance**

Adjusting this slider increases the effect of the Clean Background Noise tool without changing the edge of the foreground object.
The Primatte Matte tab

Matte Tab
The Matte tab refines the alpha of the key, combined with any solid and garbage masks connected to the node. When using the Matte tab, set the viewer to display the alpha channel of Primatte’s final output.

Filter
This control selects the filtering algorithm used when applying blur to the matte.

- **Box**: This is the fastest method but at reduced quality. Box is best suited for minimal amounts of blur.

- **Bartlett**: Otherwise known as a Pyramid filter, Bartlett makes a good compromise between speed and quality.

- **Multi-Box**: When selecting this filter, the Num Passes slider appears and lets you control the quality. At 1 and 2 passes, results are identical to Box and Bartlett, respectively. At 4 passes and above, results are usually as good as Gaussian, in less time and with no edge “ringing.”

- **Gaussian**: The Gaussian filter uses a true Gaussian approximation and gives excellent results, but it is a little slower than the other filters. In some cases, it can produce an extremely slight edge “ringing” on floating-point pixels.

Blur
Matte Blur blurs the edge of the matte based on the Filter menu setting. A value of zero results in a sharp, cutout-like hard edge. The higher the value, the more blur applied to the matte.

Blur Inward
Activating the Blur Inward checkbox generates the blur toward the center of the foreground subject. Conventional blurring or defocus affects the matte edges in both directions (inward and outward) and sometimes introduces a halo artifact around the edge in the composite view. Blur Inward functions only in the inward direction of the foreground subject (toward the center of the white area). The final result removes small and dark noise in the screen area without picking them up again in the Clean Background Noise mode. It can sometimes result in softer, cleaner edges on the foreground objects.

Contract/Expand
This slider shrinks or grows the semitransparent areas of the matte. Values above 0.0 expand the matte, while values below 0.0 contract it.
This control is usually used in conjunction with the Matte Blur to take the hard edge of a matte and reduce fringing. Since this control affects only semitransparent areas, it will have no effect on a matte's hard edge.

**Gamma**

Matte Gamma raises or lowers the values of the matte in the semitransparent areas. Higher values cause the gray areas to become more opaque, and lower values cause the gray areas to become more transparent. Completely black or white regions of the matte remain unaffected.

Since this control affects only semitransparent areas, it will have no effect on a matte's hard edge.

**Threshold**

This range slider sets the lower threshold using the handle on the left and sets the upper threshold using the handle on the right.

Any value below the lower threshold setting becomes black or transparent in the matte.

Any value above the upper threshold setting becomes white or opaque in the matte. All values within the range maintain their relative transparency values.

This control is often used to reject salt and pepper noise in the matte.

**Restore Fringe**

This restores the edge of the matte around the keyed subject. Often when keying, the edge of the subject where you have hair is clipped out. Restore Fringe brings back that edge while keeping the matte solid.

**Invert Matte**

When this checkbox is selected, the alpha channel created by the keyer is inverted, causing all transparent areas to be opaque and all opaque areas to be transparent.

**Solid Matte**

Solid mattes are mask nodes or images connected to the solid matte input on the node. The solid matte is applied directly to the alpha channel of the image. Generally, solid mattes are used to hold out keying in areas you want to remain opaque, such as someone with blue eyes against a blue screen.

Enabling Invert inverts the solid matte before it is combined with the source alpha.

**Garbage Matte**

Garbage mattes are mask nodes or images connected to the garbage matte input on the node. The garbage matte is applied directly to the alpha channel of the image. Generally, garbage mattes are used to remove unwanted elements that cannot be keyed, such as microphones and booms. They are also used to fill in areas that contain the color being keyed but that you wish to maintain.

Garbage mattes of different modes cannot be mixed within a single tool. A Matte Control node is often used after a Keyer node to add a garbage matte with the opposite effect of the matte applied to the keyer.

Enabling Invert inverts the garbage matte before it is combined with the source alpha.

**Post-Multiply Image**

Select this option to cause the keyer to multiply the color channels of the image against the alpha channel it creates for the image. This option is usually enabled and is on by default.

Deselect this checkbox and the image can no longer be considered premultiplied for purposes of merging it with other images. Use the Subtractive option of the Merge node instead of the Additive option.

For more information on these Merge node settings, see Chapter 35, “Composite Nodes” in the Fusion Reference Manual or Chapter 96 in the DaVinci Resolve Reference Manual.
Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other Matte nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

How to Key with Primatte
You begin keying with Primatte by connecting the blue- or green-screen shot to the orange foreground input on the Primatte node and the background shot for the composite into the green background input. Once the connections are made, there are four main steps to using the Primatte:

1. Select Background Color.
2. Clean the Background Noise.
3. Clean the Foreground Noise.
4. Remove Spill.

Selecting Background Color
– In the Inspector, click the Select Background Color button.
– Position the mouse pointer over the blue/green-screen area in the viewer, somewhere near the foreground subject.
– Drag over the background color.

Primatte averages the pixels to get a single color. Sometimes Primatte works best when only a single pixel is sampled instead of a range of pixels.

Should you have difficulties with your keying, try the Select Background Color operation again with a single dark screen pixel or single light screen pixel.

Instead, if you want to make a rectangular selection, use the Box button in the top left-hand corner of the viewer. The Median button is the same as Line selection, except that each point sampled is the result of a 3 x 3 region based on where you click and then apply a median filter. This can potentially reduce any noisy pixels.

Clean Background Noise
If there are any white or light gray regions in the dark screen area, this is referred to as “noise.” Technically, it is varying shades of the screen color that did not get picked up on the first sample and should be removed. You remove background noise using the Clean Background Noise button.

1. From the View Mode menu in the Inspector, select Black.
2. Above the viewer, click the Alpha Channel/RGB button.

The image displayed changes to a black and white “matte” view of the image.
3 Click the Clean Background Noise button.

4 Drag the mouse pointer through these white or light gray regions that should be pure black. Primatte processes the selection and eliminates the noise.

5 Repeat this procedure as often as necessary to clear the noise from the background areas.

Selecting Gain/Gamma from the viewer’s Options menu to increase the brightness or gamma allows you to see noise that would otherwise be invisible.

You do not need to remove every single white pixel to get good results. Most pixels displayed as a dark color close to black in a key image are considered transparent and virtually allow the background to be the final output in that area. Consequently, there is no need to eliminate all noise in the screen portions of the image. In particular, if an attempt is made to remove noise around the foreground subject meticulously, a smooth composite image is often difficult to generate.

**TIP:** When clearing noise from around loose, flying hair or any background/foreground transitional area, be careful not to select any of the areas near the edge of the hair. Leave a little noise around the hair as this can be cleaned up later using the Fine Tuning tools.

**Clean Foreground Noise**

If there are dark regions in the middle of the mostly white foreground subject, the key is not 100% in those areas. Using Clean Foreground Noise can make the matte as white as possible.

1 Keep the View Mode menu set to Black and the viewer set to the Alpha Channel.

2 Click the Clean Foreground Noise button.

3 Drag the mouse pointer through these dark pixels in the foreground that should be pure white. Primatte processes the selection and eliminates the noise.

4 Repeat this procedure as often as necessary to clear the noise from the foreground areas.

5 If enabled, disable Gain/Gamma from the viewer’s Options menu to return to a regular viewer.

**Removing Spill**

The first three sections created a clean matte. At this point, the foreground can be composited onto any background image. However, if there is color spill on the foreground subject, a final operation is necessary to remove that screen spill for a more natural-looking composite.

1 From the View Mode menu, select Composite.

2 Above the viewer, click the Alpha/RGB toggle button to see the RGB image.
There are two ways in Primatte to remove the spill color:

– **Spill Sponge**
  The quickest method is to select the Spill Sponge button and then sample the spill areas away. Additional spill removal can be done using the tools under the Fine Tuning tab or by using the Spill(-) button.

– **Fine Tuning Tab**
  To use the Fine Tuning tab for spill, first scrub over the spill color in the viewer. For most images, adjusting the Spill slider is all that is required to remove any remaining spill.

**NOTE:** When using the slider in the Fine Tuning tab to remove spill, spill color replacement is replaced based on the setting of the Spill Replacement options.

You can use the other two sliders in the same way for different key adjustments. The Detail slider controls the matte softness for the color that is closest to the background color. For example, you can recover lost rarefied smoke in the foreground by selecting the Fine Tuning mode, clicking on the area of the image where the smoke starts to disappear and moving the Detail slider to the left. The Transparency slider controls the matte softness for the color that is closest to the foreground color. For example, if you have thick and opaque smoke in the foreground, you can make it semitransparent by moving the Transparency slider to the right after selecting the pixels in the Fine Tuning mode.

---

**Ultra Keyer [UKY]**

The Ultra Keyer node

---

**Ultra Keyer Node Introduction**

Like the newer Delta Keyer, the Ultra Keyer node has two keys built in to it: a pre-matte keyer acts as a garbage matte creator and the color difference keyer that extracts fine detail and transparency. Generally, you start with the Delta Keyer as your first keyer of choice. If you do not get good results, try Primatte if you are using Fusion Studio. A good third choice is to try the Ultra Keyer.

**Inputs**

The Ultra Keyer node includes four inputs in the Node Editor.

– **Input:** The orange input accepts a 2D image that contains the color you want to be keyed for transparency.

– **Garbage Matte:** The gray garbage matte input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input causes areas of the image that fall within the matte to be made transparent. The garbage matte is applied directly to the alpha channel of the image.

– **Solid Matte:** The white solid matte input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input causes areas of the image that fall within the matte to be fully opaque.
– **Effect Mask:** The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps masks. Connecting a mask to this input limits the pixels where the keying occurs. An effects mask is applied to the tool after the tool is processed.

**Basic Node Setup**

A single keyer can rarely get perfect results because most green- or blue-screen shots have problems the keyer is not made to handle. Keyers often need the help of garbage mattes or solid mattes created with a Polygon or B-Spline node. Shots can also require more than just one keyer to achieve perfect results. Below, the Ultra Keyer node has the blue-screen content connected to the orange input. The result is an image with alpha that can then be connected into the foreground of a Merge node.

An Ultra Keyer node combined with polygon matte as a garbage matte and connected to the foreground of a Merge

**Inspector**

The Ultra Keyer Pre-Matte tab
Pre-Matte Tab

The Pre-Matte tab is where most keying begins. It is used to select the screen color and smooth out the color of the screen.

Background Color

The Background Color is used to select the color of the blue or green screen of the images. It is good practice to select the screen color close to the subject to be separated from the screen background.

Red Level, Green Level, Blue Level

These color sliders tune the level of the difference channels to help separate the color. When the background color is green, Red and Blue level options are provided. When the background color is blue, Red and Green level options are provided.

Background Correction

Depending on the background color selected above, the keyer iteratively merges the pre-keyed image over either a blue or green background before processing it further.

In some instances, this leads to better, more subtle edges.

Matte Separation

Matte Separation performs a pre-process on the image to help separate the foreground from the background before color selection. Generally, increase this control while viewing the alpha to eliminate the bulk of the background, but stop just before it starts cutting holes in the subject or eroding fine detail on the edges of the matte.

Pre-Matte Range

These R,G,B, and Luminance range controls update automatically to represent the current color selection. Colors are selected by selecting the Ultra Keyer node’s tile in the node tree and dragging the Eyedropper into the viewer to select the colors to be used to create the matte. These range controls can be used to tweak the selection slightly, although selecting colors in the viewer is all that is required.

Lock Color Picking

This checkbox prevents accidentally selecting more colors from the view. It is a good idea to activate this checkbox once the color selection is made for the matte. All other controls in the node remain editable.

Pre Matte Size

The Pre Matte Size control can be used to soften the general area around the keyed image. This is used to close holes in the matte often caused by spill in semitransparent areas of the subject. This can cause a small halo around the subject, which can be removed using the Matte Contract tools found later in the tool.

Reset Pre Matte Ranges

This discards all color selection by resetting the ranges but maintains all other slider and control values.
Image Tab

The Image tab handles the majority of spill suppression in the Ultra Keyer. Spill suppression is a form of color correction that attempts to remove the screen color from the fringe of the matte.

Spill is the transmission of the screen color through the semitransparent areas of the alpha channel. In the case of blue- or green-screen keying, this usually causes the color of the background to become apparent in the edges of the foreground subject.

Spill Suppression

When this slider is set to 0, no spill suppression is applied to the image. Increasing the slider increases the strength of the spill method.

Spill Method

This selects the strength of the algorithm used to apply spill suppression to the image.

- **None**: None is selected when no spill suppression is required.
- **Rare**: This removes very little of the spill color and is the lightest of all methods.
- **Medium**: This works best for green screens.
- **Well Done**: This works best for blue screens.
- **Burnt**: This works best for blue screens. Use this mode only for very troublesome shots.

Fringe Gamma

This control can be used to adjust the brightness of the fringe or halo that surrounds the keyed image.

Fringe Size

This expands and contracts the size of the fringe or halo surrounding the keyed image.

Fringe Shape

Fringe Shape presses the fringe toward the external edge of the image or pulls it toward the inner edge of the fringe. Its effect is most noticeable while the Fringe Size value is large.

Cyan/Red, Magenta/Green, and Yellow/Blue

Use these three controls to color correct the fringe of the image.

This is useful for correcting semitransparent pixels that still contain color from the original background to match the new background.
Matte Tab

The Matte tab refines the alpha of the key, combined with any solid and garbage masks connected to the node. When using the Matte tab, set the viewer to display the alpha channel of the Delta Keyer’s final output.

Filter

This control selects the filtering algorithm used when applying blur to the matte.

- **Box**: This is the fastest method but at reduced quality. Box is best suited for minimal amounts of blur.
- **Bartlett**: Otherwise known as a Pyramid filter, Bartlett makes a good compromise between speed and quality.
- **Multi-Box**: When selecting this filter, the Num Passes slider appears and lets you control the quality. At 1 and 2 passes, results are identical to Box and Bartlett, respectively. At 4 passes and above, results are usually as good as Gaussian, in less time and with no edge “ringing.”
- **Gaussian**: The Gaussian filter uses a true Gaussian approximation and gives excellent results, but it is a little slower than the other filters. In some cases, it can produce an extremely slight edge “ringing” on floating-point pixels.

Blur

Matte Blur blurs the edge of the matte based on the Filter menu setting. A value of zero results in a sharp, cutout-like hard edge. The higher the value, the more blur applied to the matte.

Clipping Mode

This option determines how edges are handled when performing domain of definition rendering. This is profoundly important when blurring the matte, which may require samples from portions of the image outside the current domain.

- **Frame**: The default option is Frame, which automatically sets the node’s domain of definition to use the full frame of the image, effectively ignoring the current domain of definition. If the upstream DoD is smaller than the frame, the remaining areas in the frame are treated as black/translucent.
– **Domain:** Setting this option to Domain respects the upstream domain of definition when applying the node’s effect. This can have adverse clipping effects in situations where the node employs a large filter.

– **None:** Setting this option to None does not perform any source image clipping at all. This means that any data required to process the node’s effect that would normally be outside the upstream DoD is treated as black/transparent.

**Contract/Expand**
This slider shrinks or grows the semitransparent areas of the matte. Values above 0.0 expand the matte, while values below 0.0 contract it.

This control is usually used in conjunction with the Matte Blur to take the hard edge of a matte and reduce fringing. Since this control affects only semitransparent areas, it has no effect on a matte’s hard edge.

**Gamma**
Matte Gamma raises or lowers the values of the matte in the semitransparent areas. Higher values cause the gray areas to become more opaque, and lower values cause the gray areas to become more transparent. Completely black or white regions of the matte remain unaffected.

Since this control affects only semitransparent areas, it will have no effect on a matte’s hard edge.

**Threshold**
This range slider sets the lower threshold using the handle on the left and sets the upper threshold using the handle on the right.

Any value below the lower threshold setting becomes black or transparent in the matte.

Any value above the upper threshold setting becomes white or opaque in the matte. All values within the range maintain their relative transparency values.

This control is often used to reject salt and pepper noise in the matte.

**Restore Fringe**
This restores the edge of the matte around the keyed subject. Often when keying, the edge of the subject where you have hair is clipped out. Restore Fringe brings back that edge while keeping the matte solid.

**Invert Matte**
When this checkbox is selected, the alpha channel created by the keyer is inverted, causing all transparent areas to be opaque and all opaque areas to be transparent.

**Solid Matte**
Solid mattes are mask nodes or images connected to the solid matte input on the node. The solid matte is applied directly to the alpha channel of the image. Generally, solid mattes are used to hold out keying in areas you want to remain opaque, such as someone with blue eyes against a blue screen.

Enabling Invert inverts the solid matte before it is combined with the source alpha.

**Garbage Matte**
Garbage mattes are mask nodes or images connected to the garbage matte input on the node. The garbage matte is applied directly to the alpha channel of the image. Generally, garbage mattes are used to remove unwanted elements that cannot be keyed, such as microphones and booms. They are also used to fill in areas that contain the color being keyed but that you wish to maintain.

Garbage mattes of different modes cannot be mixed within a single tool. A Matte Control node is often used after a Keyer node to add a garbage matte with the opposite effect of the matte applied to the keyer.

Enabling Invert inverts the garbage matte before it is combined with the source alpha.
**Post-Multiply Image**
Select this option to cause the keyer to multiply the color channels of the image against the alpha channel it creates for the image. This option is usually enabled and is on by default.

Deselect this checkbox and the image can no longer be considered premultiplied for purposes of merging it with other images. Use the Subtractive option of the Merge node instead of the Additive option.

For more information on these Merge node settings, see Chapter 35, “Composite Nodes” in the Fusion Reference Manual or Chapter 96 in the DaVinci Resolve Reference Manual.

**Subtract Background**
This option color corrects the edges when the screen color is removed and anti-aliased to a black background. By enabling this option, the edges potentially become darker. Disabling this option allows you to pass on the color of the screen to use in other processes down the line.

**Common Controls**

**Settings Tab**
The Settings tab in the Inspector is also duplicated in other matte nodes. These common controls are described in detail in the following “The Common Controls” section.

---

**The Common Controls**

Nodes that handle matte operations share a number of identical controls in the Inspector. This section describes controls that are common among matte nodes.

**Inspector**

![Common Matte settings Inspector](image-url)
Settings Tab
The Settings tab in the Inspector can be found on every tool in the Matte category. The controls are consistent and work the same way for each tool.

Blend
The Blend control is used to blend between the tool’s original image input and the tool’s final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming image. Usually, this causes the tool to skip processing entirely, copying the input straight to the output.

Process When Blend Is 0.0
The tool is processed even when the input value is zero. This can be useful if this node is scripted to trigger another task, but the value is set to 0.0.

Red/Green/Blue/Alpha Channel Selector
These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.

For example, if the Red button on a Blur tool is deselected, the blur is first applied to the image, and then the red channel from the original input is copied back over the red channel of the result.

There are some exceptions, such as tools where deselecting these channels causes the tool to skip processing that channel entirely. In that case, there are a set of RGBA buttons on the Controls tab in the tool. The buttons in the Settings and the Controls tabs are identical.

Apply Mask Inverted
Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

Multiply by Mask
Selecting this option causes the RGB values of the masked image to be multiplied by the mask channel’s values. This causes all pixels of the image not included in the mask (i.e., set to 0) to become black/transparent.

Use Object/Use Material (Checkboxes)
Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports Object ID and Material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels are used, if present. The specific Material ID or Object ID affected is chosen using the next set of controls.

Correct Edges
This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information on Coverage and Background Color channels, see Chapter 18, “Understanding Image Channels” in the Fusion Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.

Object ID/Material ID (Sliders)
Use these sliders to select which ID is used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker: to grab IDs from the image displayed in the view. The image or sequence must have been rendered from a 3D software package with those channels included.
**Clipping Mode**

This option determines how edges are handled when performing domain of definition rendering. This is profoundly important when blurring the matte, which may require samples from portions of the image outside the current domain.

- **Frame**: The default option is Frame, which automatically sets the node’s domain of definition to use the full frame of the image, effectively ignoring the current domain of definition. If the upstream DoD is smaller than the frame, the remaining area in the frame is treated as black/transparent.

- **Domain**: Setting this option to Domain respects the upstream domain of definition when applying the node’s effect. This can have adverse clipping effects in situations where the node employs a large filter.

- **None**: Setting this option to None does not perform any source image clipping at all. This means that any data required to process the node’s effect that would normally be outside the upstream DoD is treated as black/transparent.

**Use GPU**

The Use GPU menu has three settings. Setting the menu to Disable turns off GPU hardware-accelerated rendering. Enabled uses the GPU hardware for rendering the node. Auto uses a capable GPU if one is available, and falls back to software rendering when a capable GPU is not available.

**Hide Incoming Connections**

Enabling this checkbox can hide connection lines from incoming nodes, making a node tree appear cleaner and easier to read. When enabled, empty fields for each input on a node are displayed in the Inspector. Dragging a connected node from the node tree into the field hides that incoming connection line as long as the node is not selected in the node tree. When the node is selected in the node tree, the line reappears.

**Comments**

The Comments field is used to add notes to a tool. Click in the empty field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

**Scripts**

Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
Chapter 109

Metadata Nodes

This chapter details the Metadata nodes available in Fusion.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

Copy Metadata [META] 2136
Set Metadata [SMETA] 2137
Set Timecode [TCMETA] 2138
The Common Controls 2140
Copy Metadata [META]

The Copy Metadata node

Copy Metadata Node Introduction

Copy Metadata combines, replaces, or clears the metadata in your image. Metadata can be viewed in a subview of the viewer.

Inputs

The two inputs on the Copy Metadata node are used to connect two 2D images.

- **Background Input:** The orange background input is used for the primary 2D image that is output from the node.
- **Foreground Input:** The green foreground input is used for the secondary 2D image that contains metadata you want merge or overwrite onto the background image.

Basic Node Setup

The Copy Metadata node takes metadata from the foreground input (green) and copies it into the background input (orange). The output is the background input with modified metadata.

A Copy Metadata node copies metadata from the foreground and embeds it into the background clip

Inspector

The Copy Metadata Controls tab

Controls Tab

The Controls tab configures how metadata coming from the foreground input image gets added to the background input image.
**Operation**

The Operation menu determines how the metadata of the foreground and background inputs are treated.

- **Merge (Replace Duplicates):** All values are merged, but values with duplicate names are taken from the foreground input.
- **Merge (Preserve Duplicates):** All values are merged, but values with duplicate names are taken from the background input.
- **Replace:** The metadata in the foreground replaces the entire metadata in the background.
- **Clear:** All metadata is discarded.

**Common Controls**

**Settings Tab**

The Settings tab in the Inspector is also duplicated in other Metadata nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

### Set Metadata [SMETA]

The Set Metadata node

**Set Metadata Node Introduction**

Set Metadata allows you to create new Name = Value pairs in the metadata. Metadata can be viewed in a subview of the viewer.

**Inputs**

The single input on the Set Metadata node is used to connect a 2D image that gets metadata added.

- **Background Input:** The orange background input is used for the primary 2D image that is output from the node with the new metadata.

**Basic Node Setup**

The Set Metadata node embeds new metadata into the background input (orange). The output is the background input with new metadata.

A Set Metadata node creates new metadata and embeds it into the background clip.
Inspector

The Set Metadata Controls tab

Controls Tab
The Controls tab is where you set up the name of the metadata field and the value or information regarding the metadata.

Field Name
The name of the metadata value. Do not use spaces.

Field Value
The value assigned to the name above.

Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other Metadata nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

Set Timecode [TCMETA]

The Set Timecode node

Set Timecode Node Introduction
Set Timecode inserts dynamic timecode values into the metadata table based on the FPS settings.

Inputs
The single input on the Set Timecode node is used to connect a 2D image that gets timecode added.

- Background Input: The orange background input is used for the primary 2D image that is output from the node with the new timecode.

Basic Node Setup
The Set Timecode node embeds new timecode metadata into the background input (orange). The output is the background input with updated timecode.
A Set Timecode node inserts new timecode metadata into the background clip.

**Inspector**

The Set Timecode Controls tab

**Controls Tab**

The Controls tab sets the clip’s starting timecode metadata based on FPS, hours, minutes, seconds, and frames.

**FPS**

You can choose from a variety of settings for frames per second.

Since this is a Fuse, you can easily adapt the settings to your needs by editing the appropriate piece of code for the buttons:

```lua
MBTNC_StretchToFit = true,
{ MBTNC_AddButton = "24" },
{ MBTNC_AddButton = "25" },
{ MBTNC_AddButton = "30" },
{ MBTNC_AddButton = "48" },
{ MBTNC_AddButton = "50" },
{ MBTNC_AddButton = "60" },
```

as well as for the actual values:

```lua
local rates = { 24, 25, 30, 48, 50, 60 }
```

**Hours/Minutes/Seconds/Frames Sliders**

Define an offset from the starting frame of the current comp.
Print to Console

Verbose output of the Timecode/Frame value in the Console.

The Timecode/Frames conversion is done according to the FPS settings. The result might look like this:

**TimeCode:** 00:00:08:15

**Frames:** 207

Common Controls

Settings Tab

The Settings tab in the Inspector is also duplicated in other Metadata nodes. These common controls are described in detail in the following "The Common Controls" section.

**The Common Controls**

Nodes that handle metadata operations share several identical controls in the Inspector. This section describes controls that are common among Metadata nodes.

**Inspector**

![The Common Metadata Settings tab](image)

**Settings Tab**

The Settings tab in the Inspector can be found on every tool in the Metadata category. The controls are consistent and work the same way for each tool.

**Use Object/Use Material (Checkboxes)**

Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports Object ID and material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels are used, if present. The specific Material ID or Object ID affected is chosen using the next set of controls.
**Correct Edges**
This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information on the Coverage and Background Color channels, see Chapter 18, “Understanding Image Channels” in the Fusion Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.

**Object ID/Material ID (Sliders)**
Use these sliders to select which ID is used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker: to grab IDs from the image displayed in the view. The image or sequence must have been rendered from a 3D software package with those channels included.

**Comments**
The Comments field is used to add notes to a tool. Click in the empty field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

**Scripts**
Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
This chapter details miscellaneous nodes within Fusion.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

## Contents

<table>
<thead>
<tr>
<th>Node Name</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Domain [ADoD]</td>
<td>2143</td>
</tr>
<tr>
<td>Change Depth [CD]</td>
<td>2145</td>
</tr>
<tr>
<td>Custom Tool [CT]</td>
<td>2146</td>
</tr>
<tr>
<td>Fields [Flds]</td>
<td>2156</td>
</tr>
<tr>
<td>Frame Average [Avg]</td>
<td>2158</td>
</tr>
<tr>
<td>Keyframe Stretcher [Kfs]</td>
<td>2160</td>
</tr>
<tr>
<td>Run Command [Run]</td>
<td>2162</td>
</tr>
<tr>
<td>Set Domain [DoD]</td>
<td>2165</td>
</tr>
<tr>
<td>Time Speed [TSpd]</td>
<td>2167</td>
</tr>
<tr>
<td>Time Stretcher [Tst]</td>
<td>2170</td>
</tr>
<tr>
<td>Wireless Link [Wire]</td>
<td>2173</td>
</tr>
<tr>
<td>The Common Controls</td>
<td>2174</td>
</tr>
</tbody>
</table>
Auto Domain Node Introduction

The Auto Domain node automatically sets the image's domain of definition (DoD) based on bounds of the input image's background Canvas color. It does not change the image's physical dimensions. Some EXR images come with optimized DoDs already set, but other formats do not. For formats other than EXR, this node can speed up compositions by optimizing the DoD based on the content rather than the frame's dimensions.

For example, a CG character rarely takes up the entire frame of an image. With this type of image, the Auto Domain node sets the DoD to a rectangular region by comparing image pixels with the Canvas color. The Canvas color indicates what color the pixels are outside the DoD. By default, unless a Canvas color is set using the Set Canvas Color node, the color is set to black. This default works well when an image has a premultiplied alpha channel. The result is a DoD that encompasses the portion of the clip that contains only the character. The DoD is updated on each frame to accommodate changes, such as a character walking closer to the camera. However, if a clip does not contain an alpha channel, the Set Canvas Color node can be used to define the Canvas color as solid alpha with a color that matches the solid background.


NOTE: The Domain of Definition is a bounding box that encompasses pixels that have a nonzero value. The DoD is used to limit image-processing calculations and speeds up rendering.

Inputs

The single input on the Auto Domain node is used to connect a 2D image and an effect mask, which can be used to limit the blurred area.

- **Input**: The orange input is used for the primary 2D image that is blurred.
- **Effect Mask**: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the blur to only those pixels within the mask.

Basic Node Setup

The example below assumes that the image does not contain an alpha channel but a CG character rendered against a black background. This is common for different render passes like specular or shadows, for example. The image is connected to a Set Canvas Color node, which sets the Canvas color to black with a solid alpha. The Set Canvas Color then connects to the Auto Domain node, which detects the pixels and sets the DoD. If the original image contained a premultiplied alpha channel, the Set Canvas Color would not be needed, and the image could be connected directly into the Auto Domain node.
An Auto Domain node automatically limits the area of image processing.

Inspector

The Auto Domain Controls tab

Controls Tab
In most cases, the Auto Domain node automatically calculates the DoD bounding box; however, the rectangular shape can be modified using the Controls tab in the Inspector.

Left
Defines the left border of the search area of the ADoD. Higher values on this slider move the left border toward the right, excluding more data from the left margin.

1 represents the right border of the image; 0 represents the left border. The slider defaults to 0 (left border).

Bottom
Defines the bottom border of the search area of the ADoD. Higher values on this slider move the bottom border toward the top, excluding more data from the bottom margin.

1 represents the top border of the image; 0 represents the bottom border. The slider defaults to 0 (bottom border).

Right
Defines the right border of the search area of the ADoD. Higher values on this slider move the right border toward the left, excluding more data from the right margin.

1 represents the right border of the image; 0 represents the left border. The slider defaults to 1 (right border).

Top
Defines the top border of the search area of the ADoD. Higher values on this slider move the top border toward the bottom, excluding more data from the top margin.

1 represents the top border of the image; 0 represents the bottom border. The slider defaults to 1 (top border).

Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other miscellaneous nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
Change Depth [CD]

The Change Depth node

Change Depth Node Introduction

The Change Depth node has one simple use, and that is to change the bits per color channel used to process a node. This node is often used after color correcting 32-bit floating-point image files, converting them from float processing to 16-bit per channel to preserve memory and performance.

It can also be useful if, from a certain point in your node tree, you feel the need to process your images in a higher bit depth than their original one or to reduce the bit depth to save memory.

Inputs

The single input on the Change Depth node is used to connect a 2D image and an effect mask, which can be used to limit the blurred area.

- **Input**: The orange input is used for the primary 2D image to be converted.
- **Effect Mask**: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes or bitmaps from other tools. Connecting a mask to this input limits the blur to only those pixels within the mask.

Basic Node Setup

Below, a Loader node in Fusion Studio is color corrected and then down converted from a floating-point image to a 16-bit image to save image-processing time and memory.

A Change Depth node placed after color correction is done on a floating-point image.

Inspector

The Change Depth Controls tab
Controls Tab
The two controls for this node are the Depth menu and the Dither menu. These two menus are used to convert and adjust the color depth of the image.

Depth
The Keep setting doesn’t do anything to the image but instead keeps the input depth. The other options change the bit depth of the image to the respective value.

Dither
When down converting from a higher bit depth, it can be useful to add Error Diffusion or Additive Noise to camouflage artifacts that result from problematic (high-contrast) areas.

Common Controls
Settings Tab
The Settings tab in the Inspector is also duplicated in other miscellaneous nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Custom Tool [CT]

Custom Tool Node Introduction
The Custom Tool node is the most complex and the most powerful node in Fusion. It is used to create custom expressions and filters to modify an image. In addition to providing three image inputs, the Custom Tool node allows for the connection of up to eight numeric inputs and as many as four XY position values from other controls and parameters in the node tree.

Per-pixel calculations can be performed on the Red, Green, Blue, Alpha, Z, Z-Coverage, UV texture coords, XYZ Normals, RGBA background color, and XY motion vector channels of the images.

You should be moderately experienced with scripting, or C++ programming, to understand the structure and terminology used by the Custom Tool node.

Inputs
The Custom Tool node has three image inputs, a matte input, and an effect mask input.

– Input: The orange, green, and magenta inputs combine 2D images to make your composite. When entering them into the Custom Tool fields, they are referred to as c1, c2 and c3 (c standard for all three R, G, B channels)

– Matte Input: The white input is for a matte created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a matte to this input allows a matte to be combined into any equation. When entering the matte into the Custom Tool fields, it is referred to as m1.

– Effect Mask: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the Custom Tool effect to only those pixels within the mask.
Basic Node Setup

The Custom Tool below takes two image inputs and a matte input, and then combines them using some calculation. The result can be output to a Merge or other image-processing nodes.

A Custom Tool is used to build your own effects using C++ and scripting.

Inspector

Controls Tab

**Point in 1-4, X and Y**

These four controls are 2D X and Y center controls that are available to expressions entered in the Setup, Intermediate, and Channels tabs as variables p1x, p1y, ..., p4x, p4y. They are normal positional controls and can be animated or connected to modifiers as any other node might.

**Number in 1-8**

The values of these controls are available to expressions entered in the Setup, Intermediate, and Channels tabs as variables n1, n2, n3, ..., n8. They are normal slider controls and can be animated or connected to modifiers exactly as any other node might.
LUT in 1-4

The Custom Tool node provides 4 LUT splines. The values of these controls are available to expressions entered in the Setup, Intermediate, and Channels tabs using the getlut# function. For example, setting the R, G, B, and A expressions to getlut1(r1), getlut2(g1), getlut3(b1), and getlut4(a1), respectively, would cause the Custom Tool node to mimic the Color Curves node.

These controls can be renamed using the options in the Config tab to make their meanings more apparent, but expressions still see the values as n1, n2, ..., n8.

Custom Tool Setup Tab

The Custom Tool Setup tab

Setup 1-4

Up to four separate expressions can be calculated in the Setup tab of the Custom Tool node. The Setup expressions are evaluated once per frame before any other calculations are performed. The results are then made available to the other expressions in the Custom Tool node as variables s1, s2, s3, and s4.

NOTE: Because these expressions are evaluated once per frame only and not for each pixel, it makes no sense to use per-pixel variables like X and Y or channel variables like r1, g1, b1. Allowable values include constants, variables such as n1..n8, time, W and H, and functions like sin(f) or getr1d().
Custom Tool Intermediate Tab

Intermediate 1-4
An additional four expressions can be calculated in the Inter tab. The Inter expressions are evaluated once per pixel after the Setup expressions are evaluated but before the Channel expressions are evaluated. Per-pixel channel variables like r1, g1, b1, and a1 are allowable. Results are available as variables i1, i2, i3, and i4.

Custom Tool Config Tab
Random Seed
Use this to set the seed for the rand() and rands() functions. Click the Randomize button to set the seed to a random value. This control may be needed if multiple Custom Tool nodes are required with different random results for each.

Number Controls
There are eight sets of Number controls, corresponding to the eight Number In sliders in the Controls tab. Uncheck the Show Number checkbox to hide the corresponding Number In slider, or edit the Name for Number text field to change its name.

Point Controls
There are four sets of Point controls, corresponding to the four Point In controls in the Controls tab. Uncheck the Show Point checkbox to hide the corresponding Point In control and its crosshair in the viewer. Similarly, edit the Name for Point text field to change the control’s name.

Custom Tool Channels Tab

![Custom Tool Channel tab]

The Custom Tool Channel tab

RGBA, Z, UV Expressions, and XYZ Normal Expressions
The Channel tab is used to set up one expression per each available channel of the image. Each expression is evaluated once per pixel. The result creates the value for that pixel in the output of the image.

Color Channel expressions (RGBA) should generally return floating-point values between 0.0 and 1.0. Values beyond this are clipped if the destination image is an integer. Other expression fields should produce values appropriate to their channel (e.g., between -1.0 and 1.0 for Vector and Normal fields, 0.0 to 1.0 for Coverage, or any value for Depth). The Channel expressions may use the results from both the Setup expressions (as variables s1–s4) and Inter expressions (as variables i1–i4).

Custom Tool Node Syntax

<table>
<thead>
<tr>
<th>Value Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>n1..n8</td>
<td>Numeric Inputs</td>
</tr>
<tr>
<td>pfx..p4x</td>
<td>Position Values (X-axis)</td>
</tr>
<tr>
<td>pfy..p4y</td>
<td>Position Values (Y-axis)</td>
</tr>
<tr>
<td>s1..s4</td>
<td>Setup Expression Results</td>
</tr>
</tbody>
</table>
### Value Variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>i1..i4</td>
<td>Inter Expression Results</td>
</tr>
<tr>
<td>time</td>
<td>Current Frame</td>
</tr>
<tr>
<td>x</td>
<td>Horizontal co-ordinate of the current pixel, between 0.0 and 1.0</td>
</tr>
<tr>
<td>y</td>
<td>Vertical co-ordinate of the current pixel, between 0.0 and 1.0</td>
</tr>
<tr>
<td>w (or w1..w3)</td>
<td>Width of Image (for image1..image3)</td>
</tr>
<tr>
<td>h (or h1..h3)</td>
<td>Height of Image (for image1..image3)</td>
</tr>
<tr>
<td>ax (or ax1..ax3)</td>
<td>Image Aspect X (for image1..image3)</td>
</tr>
<tr>
<td>ay (or ay1..ay3)</td>
<td>Image Aspect Y (for image1..image3)</td>
</tr>
</tbody>
</table>

**NOTE:** Use w and h and ax and ay without a following number to get the dimensions and aspect of the primary image.

### Channel (Pixel) Variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>c1..c3</td>
<td>Current Channel (for image1..image3)</td>
</tr>
<tr>
<td>r1..r3</td>
<td>Red (for image1..image3)</td>
</tr>
<tr>
<td>g1..g3</td>
<td>Green (for image1..image3)</td>
</tr>
<tr>
<td>b1..b3</td>
<td>Blue (for image1..image3)</td>
</tr>
<tr>
<td>a1..a3</td>
<td>Alpha (for image1..image3)</td>
</tr>
<tr>
<td>z1..z3</td>
<td>Z-Buffer (for image1..image3)</td>
</tr>
<tr>
<td>cv1..cv3</td>
<td>Z Coverage (for image1..image3)</td>
</tr>
<tr>
<td>u1..u3</td>
<td>U Coordinate (for image1..image3)</td>
</tr>
<tr>
<td>v1..v3</td>
<td>V Coordinate (for image1..image3)</td>
</tr>
<tr>
<td>nx1..nx3</td>
<td>X Normal (for image1..image3)</td>
</tr>
<tr>
<td>ny1..ny3</td>
<td>Y Normal (for image1..image3)</td>
</tr>
<tr>
<td>nz1..nz3</td>
<td>Z Normal (for image1..image3)</td>
</tr>
<tr>
<td>bgr1..bgr3</td>
<td>Background Red (for image1..image3)</td>
</tr>
<tr>
<td>bgg1..bgg3</td>
<td>Background Green (for image1..image3)</td>
</tr>
<tr>
<td>bgb1..bgb3</td>
<td>Background Blue (for image1..image3)</td>
</tr>
<tr>
<td>bga1..bga3</td>
<td>Background Alpha (for image1..image3)</td>
</tr>
<tr>
<td>vx1..vx3</td>
<td>X Vector (for image1..image3)</td>
</tr>
<tr>
<td>vy1..vy3</td>
<td>Y Vector (for image1..image3)</td>
</tr>
<tr>
<td>nz1..nz3</td>
<td>Z Normal (for image1..image3)</td>
</tr>
</tbody>
</table>

**NOTE:** Use c1, c2, c3 to refer to the value of a pixel in the current channel. This makes copying and pasting expressions easier. For example, if c1/2 is typed as the red expression, the result would be half the value of the red pixel from image 1, but if the expression is copied to the blue channel, now it would have the value of the pixel from the blue channel.
To refer to the red value of the current pixel in input 1, type r1. For the image in input 2, it would be r2.

- `get[ch][#]b(x, y)` Read pixel at x,y, or 0 if out of bounds—e.g., `getr1b(0,0)`
- `get[ch][#]d(x, y)` Read pixel at x,y or edge pixel if out of bounds—e.g., `getr1d(0,0)`
- `get[ch][#]w(x, y)` Read pixel at x,y or wrap if out of bounds—e.g., `getr1w(0,0)`

**NOTE:** There are a variety of methods used to refer to pixels from locations other than the current one in an image.

In the above description, [ch] is a letter representing the channel to access. The [#] is a number representing the input image. So to get the red component of the current pixel (equivalent to r), you would use `getr1b(x,y)`. To get the alpha component of the pixel at the center of image 2, you would use `geta2b(0.5, 0.5).

- `getr1b(x,y)` Output the red value of the pixel at position x, y, if there were a valid pixel present. It would output 0.0 if the position were beyond the boundaries of the image (all channels).
- `getr1d(x,y)` Output the red value of the pixel at position x, y. If the position specified were outside of the boundaries of the image, the result would be from the outer edge of the image (RGBA only).
- `getr1w(x,y)` Output the red value of the pixel at position x, y. If the position specified were outside of the boundaries of the image, the x and y coordinates would wrap around to the other side of the image and continue from there (RGBA only).

To access other channel values with these functions, substitute the r in the above examples with the correct channel variable (r, g, b, a and, for the getr1b() functions only, z, and so on), as shown above. Substitute the 1 with either 2 or 3 in the above examples to access the images from the other input images.

<table>
<thead>
<tr>
<th><strong>Mathematical Expressions</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>pi</td>
<td>The value of π</td>
</tr>
<tr>
<td>e</td>
<td>The value of e</td>
</tr>
<tr>
<td>log(x)</td>
<td>The base-10 log of x</td>
</tr>
<tr>
<td>ln(x)</td>
<td>The natural (base-e) log of x</td>
</tr>
<tr>
<td>sin(x)</td>
<td>The sine of x (x is degrees)</td>
</tr>
<tr>
<td>cos(x)</td>
<td>The cosine of x (x is degrees)</td>
</tr>
<tr>
<td>tan(x)</td>
<td>The tangent of x (x is degrees)</td>
</tr>
<tr>
<td>asin(x)</td>
<td>The arcsine of x, in degrees</td>
</tr>
<tr>
<td>acos(x)</td>
<td>The arccosine of x, in degrees</td>
</tr>
<tr>
<td>atan(x)</td>
<td>The arctangent of x, in degrees</td>
</tr>
<tr>
<td>atan2(x,y)</td>
<td>The arctangent of x,y, in degrees</td>
</tr>
<tr>
<td>abs(x)</td>
<td>The absolute (positive) value of x</td>
</tr>
<tr>
<td>int(x)</td>
<td>The integer (whole) value of x</td>
</tr>
<tr>
<td>frac(x)</td>
<td>The fractional value of x</td>
</tr>
<tr>
<td>sqrt(x)</td>
<td>The Square Root of x</td>
</tr>
</tbody>
</table>
### Mathematical Expressions

<table>
<thead>
<tr>
<th>Expression</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>rand(x, y)</code></td>
<td>A random value between x and y</td>
</tr>
<tr>
<td><code>rands(x, y, s)</code></td>
<td>A random value between x and y, based on seed s</td>
</tr>
<tr>
<td><code>min(x, y)</code></td>
<td>The minimum (lowest) of x and y</td>
</tr>
<tr>
<td><code>max(x, y)</code></td>
<td>The maximum (highest) of x and y</td>
</tr>
<tr>
<td><code>dist(x1,y1,x2,y2)</code></td>
<td>The distance between point x1,y2 and x2,y2</td>
</tr>
<tr>
<td><code>dist3d(x1,y1,z1,x2,y2,z2)</code></td>
<td>The distance between 3D points x1,y2,z1 and x2,y2,z2</td>
</tr>
<tr>
<td><code>noise(x)</code></td>
<td>A smoothly varying Perlin noise value based on x</td>
</tr>
<tr>
<td><code>noise2(x, y)</code></td>
<td>A smoothly varying Perlin noise value based on x and y</td>
</tr>
<tr>
<td><code>noise3(x, y, z)</code></td>
<td>A smoothly varying Perlin noise value based on x, y and z</td>
</tr>
<tr>
<td><code>if(c, x, y)</code></td>
<td>returns x if c not 0, otherwise y</td>
</tr>
</tbody>
</table>

### Mathematical Operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>!x</code></td>
<td>1.0 if x = 0, otherwise 0.0</td>
</tr>
<tr>
<td><code>-x</code></td>
<td>(0.0 - x)</td>
</tr>
<tr>
<td><code>+x</code></td>
<td>(0.0 + x) i.e. effectively does nothing</td>
</tr>
<tr>
<td><code>x^y</code></td>
<td>x raised to the power of y</td>
</tr>
<tr>
<td><code>x*y</code></td>
<td>x multiplied by y</td>
</tr>
<tr>
<td><code>x/y</code></td>
<td>x divided by y</td>
</tr>
<tr>
<td><code>x%y</code></td>
<td>x modulo y, i.e. remainder of (x divided by y)</td>
</tr>
<tr>
<td><code>x+y</code></td>
<td>x plus y</td>
</tr>
<tr>
<td><code>x-y</code></td>
<td>x minus y</td>
</tr>
<tr>
<td><code>x&lt;y</code></td>
<td>1.0 if x is less than y, otherwise 0.0</td>
</tr>
<tr>
<td><code>x&gt;y</code></td>
<td>1.0 if x is greater than y, otherwise 0.0</td>
</tr>
<tr>
<td><code>x&lt;=y</code></td>
<td>1.0 if x is less than or equal to y, otherwise 0.0</td>
</tr>
<tr>
<td><code>x&gt;=y</code></td>
<td>1.0 if x is greater than or equal to y, otherwise 0.0</td>
</tr>
<tr>
<td><code>x=y</code></td>
<td>1.0 if x is exactly equal to y, otherwise 0.0</td>
</tr>
<tr>
<td><code>x==y</code></td>
<td>1.0 if x is exactly equal to y, otherwise 0.0, identical to above</td>
</tr>
<tr>
<td><code>x&lt;&gt;y</code></td>
<td>1.0 if x is not equal to y, otherwise 0.0, i.e. identical to above</td>
</tr>
<tr>
<td><code>x!y</code></td>
<td>1.0 if both x and y are not 0.0, otherwise 0.0</td>
</tr>
<tr>
<td><code>x&amp;y</code></td>
<td>1.0 if both x and y are not 0.0, otherwise 0.0, i.e. identical to above</td>
</tr>
<tr>
<td>`x</td>
<td>y`</td>
</tr>
<tr>
<td>`x</td>
<td>y`</td>
</tr>
</tbody>
</table>
Example
The following examples are intended to help you understand the various components of the Custom Tool node.

Rotation
To rotate an image, we need the standard equations for 2D rotation:

\[ x' = x \cdot \cos(\theta) - y \cdot \sin(\theta) \]
\[ y' = x \cdot \sin(\theta) + y \cdot \cos(\theta) \]

Using the n1 slider for the angle theta, and a sample function, we get (for the red channel):

```
getr1b(x * \cos(n1) - y * \sin(n1), x * \sin(n1) + y * \cos(n1))
```

This calculates the current pixel’s (x,y) position rotated around the origin at (0,0) (the bottom-left corner), and then fetches the red component from the source pixel at this rotated position. For centered rotation, we need to subtract 0.5 from our x and y coordinates before we rotate them, and add 0.5 back to them afterward:

```
getr1b((x-.5) * \cos(n1) - (y-.5) * \sin(n1) + .5, (x-.5) * \sin(n1) + (y-.5) * \cos(n1) + .5)
```

Which brings us to the next lesson: Setup and Intermediate Expressions. These are useful for speeding things up by minimizing the work that gets done in the Channel expressions. The Setup expressions are executed only once, and their results don’t change for any pixel, so you can use these for s1 and s2, respectively.

```
\cos(n1) \sin(n1)
```

Intermediate expressions are executed once for each pixel, so you can use these for i1 and i2:

```
(x-.5) * s1 - (y-.5) * s2 + .5
(x-.5) * s2 + (y-.5) * s1 + .5
```

These are the x and y parameters for the getr1b() function from above, but with the Setup results, s1 and s2, substituted so that the trig functions are executed only once per frame, not every pixel. Now you can use these intermediate results in your Channel expressions:

```
getr1b(i1, i2)
gegl1b(i1, i2)
getb1b(i1, i2)
geta1b(i1, i2)
```

With the intermediate expressions substituted in, we only have to do all the additions, subtractions, and multiplications once per pixel, instead of four times. As a rule of thumb, if it doesn’t change, do it only once.

This is a simple rotation that doesn’t take into account the image aspect at all. It is left as an exercise for you to include this (sorry). Another improvement could be to allow rotation around points other than the center.

Filtering
Our second example duplicates the functionality of a 3 x 3 Custom Filter node set to average the current pixel together with the eight pixels surrounding it. To duplicate it with a Custom Tool node, add a Custom Tool node to the node tree, and enter the following expressions into the Setup tab.
These two expressions are evaluated at the beginning of each frame. S1 divides 1.0 by the current width of the frame, and S2 divides 1.0 by the height. This provides a floating-point value between 0.0 and 1.0 that represents the distance from the current pixel to the next pixel along each axis.

Now enter the following expression into the first text control of the Channel tab (r).

\[
\frac{(\text{getr1w}(x-s1, y-s2) + \text{getr1w}(x, y-s2) + \text{getr1w}(x+s1, y-s2) + \text{getr1w}(x+s1, y) + \text{getr1w}(x-s1, y) + r1 + \text{getr1w}(x-s1, y+s2) + \text{getr1w}(x, y+s2) + \text{getr1w}(x+s1, y+s2))}{9}
\]

This expression adds together the nine pixels above the current pixel by calling the getr1w() function nine times and providing it with values relative to the current position. Note that we referred to the pixels by using x+s1, y+s2, rather than using x+1, y+1.

Fusion refers to pixels as floating-point values between 0.0 and 1.0, which is why we created the expressions we used in the Setup tab. If we had used x+1, y+1 instead, the expression would have sampled the same pixel over and over again. (The function we used wraps the pixel position around the image if the offset values are out of range.)

That took care of the red channel; now use the following expressions for the green, blue, and alpha channels.

\[
\frac{(\text{getglw}(x-s1, y-s2) + \text{getglw}(x, y-s2) + \text{getglw}(x+s1, y-s2) + \text{getglw}(x+s1, y) + \text{getglw}(x-s1, y) + g1 + \text{getglw}(x-s1, y+s2) + \text{getglw}(x, y+s2) + \text{getglw}(x+s1, y+s2))}{9}
\]

\[
\frac{(\text{getblw}(x-s1, y-s2) + \text{getblw}(x, y-s2) + \text{getblw}(x+s1, y-s2) + \text{getblw}(x+s1, y) + \text{getblw}(x-s1, y) + b1 + \text{getblw}(x-s1, y+s2) + \text{getblw}(x, y+s2) + \text{getblw}(x+s1, y+s2))}{9}
\]

\[
\frac{(\text{getalw}(x-s1, y-s2) + \text{getalw}(x, y-s2) + \text{getalw}(x+s1, y-s2) + \text{getalw}(x+s1, y) + \text{getalw}(x-s1, y) + a1 + \text{getalw}(x-s1, y+s2) + \text{getalw}(x, y+s2) + \text{getalw}(x+s1, y+s2))}{9}
\]

It’s time to view the results. Add a Background node set to a solid color and change the color to a pure red. Add a hard-edged Rectangular effects mask and connect it to the expression just created.

For comparison, add a Custom Filter node and duplicate the settings from the image above. Connect a pipe to this node from the background to the node and view the results. Alternate between viewing the Custom Tool node and the Custom Filter while zoomed in close to the top corners of the effects mask.

Of course, the Custom Filter node renders a lot faster than the Custom Tool node we created, but the flexibility of the Custom Tool node is its primary advantage. For example, you could use an image connected to input 2 to control the median applied to input one by changing all instances of getr1w, getglw, and getblw in the expression to getr2w, getg2w, and getb2w, but leaving the r1, g1, and b1s as they are.

This is just one example; the possibilities of the Custom Tool node are limitless.
Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other miscellaneous nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Fields [Flds]

The Fields node

Fields Node Introduction
The Fields node is a robust multipurpose utility offering several functions related to interlaced video frames. It interpolates video fields into frames or video frames into fields. Although the interlace preference and method type is defined in the MediaIn or Loader, and generators, this node can be used to assist in the standards conversion of PAL to NTSC and provides the ability to process fields and frames for specific portions of a node tree.

This node can also interlace two separate images together into a single interlace image. The background input is the dominate field 1 and the foreground is field 2.

Inputs
The single input on the Fields node is used to connect a 2D image and an effect mask, which can be used to limit the blurred area.

– **Stream1 Input**: The orange background input is used for the primary 2D image that is interpolated or converted.

– **Stream2 Input**: The optional green foreground input is only used when merging two interlaced images together.

Basic Node Setup
The Fields node below is used to convert the background image from a PAL interlaced format to progressive frames.

The background image can be modified to various interlaced formats.
Controls Tab

The Controls tab includes two menus. The Operation menu is used to select the type of field conversion performed. The Process Mode menu is used to select the field's format for the output image.

Operation Mode

**Operation Menu**

- **Do Nothing:** This causes the images to be affected by the Process Mode selection exclusively.
- **Strip Field 2:** This removes field 2 from the input image stream, which shortens the image to half of the original height.
- **Strip Field 1:** This removes field 1 from the input image stream, which shortens the image to half of the original height.
- **Strip Field 2 and Interpolate:** This removes field 2 from the input image stream and inserts a field interpolated from field 1 so that image height is maintained. Should be supplied with frames, not fields.
- **Strip Field 1 and Interpolate:** This removes field 1 from the input image stream and inserts a field interpolated from field 2 so that image height is maintained. Should be supplied with frames, not fields.
- **Interlace:** This combines fields from the input image stream(s). If supplied with one image stream, each pair of frames are combined to form half of the number of double-height frames. If supplied with two image streams, single frames from each stream are combined to form double-height images.
- **De-Interlace:** This separates fields from one input image stream. This will produce double the amount of half-height frames.
Reverse Field Dominance
When selected, the Field Order or Dominance of the image will be swapped.

Process Mode

Process Mode Menu
– **Full Frames:** This forces Frame Processing. Useful for processing frames in a part of a node tree that is otherwise field processing.
– **NTSC Fields:** This forces NTSC Field Processing. Useful for processing fields in a part of a node tree that is otherwise frame processing.
– **PAL Fields:** This forces PAL Field Processing. Useful for processing fields in a part of a node tree that is otherwise frame processing.
– **PAL Fields (Reversed):** This forces PAL-swapped Field Processing.
– **NTSC Fields (Reversed):** This forces NTSC-swapped Field Processing.
– **Auto:** This attempts to match the mode of its input images. Fields are used if the input types are mixed.

Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other miscellaneous nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

**Frame Average [Avg]**

The Frame Average node

**Frame Average Node Introduction**
The Frame Average node averages together a series of frames to simulate clips shot with long shutter speeds. Aside from motion blur-style effects, it can be useful for time warps or noise removal.
Inputs
The single input on the Frame Average node is used to connect a 2D image that will have the averaging applied.

- **Input:** The orange input is used for the primary 2D image that will be averaged.

Basic Node Setup
The image connected to the orange input is frame averaged based on the settings in the Inspector.

![Frame Average node blending input image's frames](image)

A Frame Average node blends the input image’s frames.

Inspector

![Frame Average Controls tab](image)

The Frame Average Controls tab

Controls Tab
The Controls tab contains the parameters for setting the duration and guidance of the averaged frames.

**Sample Direction**
The Sample Direction menu determines if the averaged frames are taken before the current frame, after, or a mix of the two.

- **Forward:** Averages the number of frames set by the Frames slider after the current frame.
- **Both:** Averages the number of frames set by the Frames slider, taking frames before and after the current frame.
- **Backward:** Averages the number of frames set by the Frames slider before the current frame.

**Missing Frames**
This control determines the behavior if a frame is missing from the clip.

- **Duplicate Original:** Uses the last original frame until a new frame is available.
- **Blank Frame:** Leaves missing frames blank.

**Frames**
This slider sets the number of frames that are averaged.
Keyframe Stretcher Node Introduction

The Keyframe Stretcher node is inserted after animated nodes, so the keyframes stretch and the comp's duration is modified. It is used to scale the keyframes on the animation curve to the current duration of the clip. This is particularly useful when creating title templates in Fusion for use in DaVinci Resolve’s Edit or Cut page.

**TIP:** The Keyframe Stretcher can be used on a single parameter by applying the Keystretcher modifier.

Inputs

The single input on the Keyframe Stretcher node is used to connect a 2D image that contains keyframe animation.

- **Input:** The orange input is used for any node with keyframed animation. The input can be a Merge node that is not animated but contains foreground and background nodes that are animated.

Basic Node Setup

The Keyframe Stretcher is added just before the Media Out or Saver node. All nodes that include animation before the Keyframe Stretcher are modified if the comp changes duration.

The diagram below shows the original 50-frame animation added to a parameter. The Keyframe Stretcher Start and End would be set to 0 and 50. The second keyframe is set at frame 10, and the third keyframe is set at frame 40. Setting the Stretch Start to frame 11 and the Stretch End to frame 39 will keep the existing keyframes at the same speed (number of frames.) The middle will be stretched.
In the below example, the duration of the clip is extended to 75 frames. The first 10 frames and the last 10 frames of the animation run at the same speed as the original animation, while any animation in the middle is stretched to fill the difference.

**NOTE:** The actual Spline Editor will show only the original keyframe positions. The splines are not changed by the Keyframe Stretcher; only the animation is changed.

The Keyframe Stretcher Keyframes tab

**Keyframes Tab**

The Keyframes tab includes Source controls for setting the source duration and Stretch controls for setting the area of the animation that gets modified.

**Source Start/Source End**

A source range is specified using the Source Start and Source End controls. These are typically set to match the full range of the animation spline on the Keyframes control.
**Stretch Start/Stretch End**

The Stretch Start and Stretch End controls let you specify a middle zone where keyframes will be stretched or squished. Handles outside the range will not get scaled. Any keyframes outside the Stretch Start and End range always remain the same number of frames from the Start and End.

Any keyframe adjustments to the original control will be correspondingly scaled back to the source curve and will match the original timing as expected.

**Stretch Edges Instead**

Enabling the Stretch Edges Instead checkbox overrides the Stretch Start and Stretch End controls and stretches the edges of the animation.

---

**Run Command [Run]**

**Run Command Node Introduction**

The Run Command node is used to execute an external command or batch file at specific points during a render. You can choose to run a command at the start or the end of a render. Or you can have the command execute once for each frame.

The Run Command can be used to net render other command line applications using the Fusion Render Manager, as well as a host of other useful functions.

**Inputs**

The single input on the Run Command node is used to pass through a 2D image.

- **Input**: The optional orange image input is not required for this node to operate. However, if it is connected to a node's output, the Run Command will only launch after the connected node has finished rendering. This is often useful when connected to a Saver, to ensure that the output frame has been fully saved to disk first. If the application launched returns a non-zero result, the node will also fail.

**Basic Node Setup**

The Run Command node can be connected after a Saver and run once the final frame is completed.
Frame Tab
The Frame tab is where the command to execute is selected and modified.

Hide
Enable the Hide checkbox to prevent the application or script from displaying a window when it is executed.

Wait
Enable this checkbox to cause the node to wait for a remote application or tool to exit before continuing. If this checkbox is disabled, the Fusion continues rendering without waiting for the external application.

Frame Command
This field is used to specify the path for the command to be run after each frame is rendered. The Browse button can be used to identify the path.

Interactive
This checkbox determines whether the launched application should run interactively, allowing user input.

Number A (%a) and Number B (%b)
Various wildcards can be used with the frame commands; these wildcards will be substituted at render time with the correct values.

- %a: Outputs the number from the Number A thumbwheel control.
- %b: Outputs the number from the Number B thumbwheel control.
- %t: Outputs the current frame number (without zero padding).
- %s: Substitutes using the text from the large text entry field.

If you want to add zero paddings to the numbers generated by %t, refer to the wildcard with %0x, where x is the number of characters with which to pad the value. This also works for %a and %b.
For example, test%04t.tga would return the following values at render time:

- test0000.tga
- test0001.tga
- test0009.tga
- test0010.tga

You may also pad a value with spaces by calling the wildcard as %x, where x is the number of spaces with which you would like to pad the value.

**Start and End Tabs**

The Start and End tabs contain a file browser for a command to be run when the composition starts to render and when the composition is done rendering.

**Example**

To copy the saved files from a render to another directory as each frame is rendered, save the following text in a file called copyfile.bat to your C\ directory (the root folder).

```batch
@echo off
set parm=%1 %2
copy %1 %2 set parm=
```

Create or load any node tree that contains a Saver. The following example assumes a Saver is set to output D\test0000.exr, test0001.exr, etc. You may have to modify the example to match.

Add a Run Command node after the Saver to ensure the Saver has finished saving first. Now enter the following text into the Run Command node’s Frame Command text box:

```batch
C\copytest.bat D\test%04f.exr C\n```

Select the Hide Frame command checkbox to prevent the Command Prompt window from appearing briefly after every frame.

When this node tree is rendered, each file will be immediately copied to the C\ directory as it is rendered.

The Run Command node could be used to transfer the files via FTP to a remote drive on the network, to print out each frame as it is rendered, or to execute a custom image-processing tool.

The Run Command node is not restricted to executing simple batch files. FusionScript, VBScript, Jscript, CGI, and Perl files could also be used, as just a few examples.
Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other miscellaneous nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Set Domain [DoD]

The Set Domain node

Set Domain Node Introduction
Set Domain is used to adjust or set the active area of an image or the area of the image considered to have valid data.

It does not change the image’s physical dimensions. Downstream nodes will not process anything outside the Domain of Definition (DoD), thus speeding up rendering of computation-intensive nodes.

This node provides an absolute mode, for setting the domain of definition manually, and a relative mode for adjusting the existing domain of definition.

Inputs
The two inputs on the Set Domain node are used to connect 2D images.

– **Input**: The orange background input must be connected. It accepts a 2D image with the DoD you want to replace or adjust.

– **Foreground**: The green image input is optional but also accepts a 2D image as its input. When the foreground input is connected, the Set Domain node will replace the Background input’s domain of definition with the foreground’s DoD.

Basic Node Setup
The example below assumes an image is connected to a Set Domain node to manually configure the DoD.

A Set Domain node manually sets the area to limit image processing.
Inspector

Controls Tab

Mode
The Mode menu has two choices depending on whether you want to adjust or offset the existing domain or set precise values for it.

The same operations can be performed in Set or in Adjust mode. In Adjust mode, the sliders default to 0, marking their respective full extent of the image. Positive values shrink the DoD while negative values expand the DoD to include more data.

Set mode defaults to the full extent of the visible image. Sliders default to a scale of 0-1 from left to right and bottom to top.

Left
Defines the left border of the DoD. Higher values on this slider move the left border toward the right, excluding more data from the left margin.

1 represents the right border of the image; 0 represents the left border. The slider defaults to 0 (left border).

Bottom
Defines the bottom border of the DoD. Higher values on this slider move the bottom border toward the top, excluding more data from the bottom margin.

1 represents the top border of the image; 0 represents the bottom border. The slider defaults to 0 (bottom border).

Right
Defines the right border of the DoD. Higher values on this slider move the right border toward the left, excluding more data from the right margin.

1 represents the right border of the image; 0 represents the left border. In Set mode, the slider defaults to 1 (right border).

Top
Defines the top border of the DoD. Higher values on this slider move the top border toward the bottom, excluding more data from the top margin.

1 represents the top border of the image; 0 represents the bottom border. In Set mode, the slider defaults to 1 (top border).
Common Controls

Settings Tab

The Settings tab in the Inspector is also duplicated in other miscellaneous nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Time Speed [TSpd]

Time Speed Node Introduction

The Time Speed node allows image sequences to be sped up, slowed down, reversed, or delayed. Image Interpolation offers smooth, high-quality results. Time Speed should be used for static speed changes or to introduce delays in the footage. To apply animated changes in time, such as accelerating or decelerating time, use a Time Stretcher instead.

When operating in Flow mode, Optical Flow data is required. This node does not generate optical flow directly. You have to create it upstream using an Optical Flow node or by loading the forward/reverse vector channels from the image.

TimeSpeed does not interpolate the aux channels but instead destroys them. In particular, the Vector/BackVector channels are consumed and destroyed after computation.

Add an Optical Flow after the Time Speed node if you want to generate flow vectors for the retimed footage.

Inputs

The single input on the Time Speed node is used to connect a 2D image that will be retimed.

– Input: The orange input is used for the primary 2D image that will be retimed.
Basic Node Setup
The Time Speed node setup is as simple as connecting a 2D image into the orange background input of the node.

A MediaIn node having its speed changed in the Time Speed node.

Inspector

The Time Speed Controls tab

**Speed**
This control is used to adjust the Speed, in percentage values, of the outgoing image sequence. Negative values reverse the image sequence. 200% Speed is represented by a value of 2.0, 100% by 1.0, 50% by 0.5, and 10% by 0.1.

The Speed control cannot be animated.

**Delay**
Use this control to Delay the outgoing image sequence by the specified number of frames. Negative numbers offset time back, and positive numbers advance time.

**Interpolate Mode**
This menu determines the how the time speed is processed in order to improve its visual playback quality, especially in the case of clips that are slowed down. There are three choices in the menu.

- **Nearest:** The most processor efficient and least sophisticated method of processing; frames are either dropped for fast motion or duplicated for slow motion.
- **Blend:** Also processor efficient, but can produce smoother results; adjacent duplicated frames are dissolved together to smooth out slow or fast motion effects.
- **Flow:** The most processor intensive but highest quality method of speed effect processing. Using vector channels pre-generated from an Optical Flow node, new frames are generated to create slow or fast motion effects. The result can be exceptionally smooth when motion in a clip is linear. However, two moving elements crossing in different directions or unpredictable camera movement can cause unwanted artifacts.
Sample Spread
This slider is displayed only when Interpolation is set to Blend. The slider controls the strength of the interpolated frames on the current frame. A value of 0.5 blends 50% of the frame before and 50% of the frame ahead and 0% of the current frame.

Depth Ordering
This menu is displayed only when Interpolation is set to Flow. The Depth Ordering is used to determine which parts of the image should be rendered on top. This is best explained by example.

In a locked-off camera shot where a car is moving through the frame, the background does not move, so it produces small, or slow, vectors. The car produces larger, or faster, vectors.

The Depth Ordering, in this case, is Fastest on Top, since the car draws over the background.

In a shot where the camera pans to follow the car, the background has faster vectors, and the car has slower vectors, so the Depth ordering method would be Slowest on Top.

Clamp Edges
This checkbox is displayed only when Interpolation is set to Flow. Under certain circumstances, this option can remove the transparent gaps that may appear on the edges of interpolated frames. Clamp Edges can cause a stretching artifact near the edges of the frame that is especially visible with objects moving through it or when the camera is moving.

Because of these artifacts, it is a good idea to use clamp edges only to correct small gaps around the edges of an interpolated frame.

Edge Softness
This slider is only displayed when Interpolation is set to Flow and Clamp Edges is enabled. It helps to reduce the stretchy artifacts that might be introduced by Clamp Edges.

If you have more than one of the Source Frame and Warp Direction checkboxes turned on, this can lead to doubling up of the stretching effect near the edges. In this case, you'll want to keep the softness rather small at around 0.01. If you have only one checkbox enabled, you can use a larger softness at around 0.03.

Source Frame and Warp Direction
These checkboxes are displayed only when Interpolation is set to Flow. These controls determine which frames and which vectors are used to create the in-between frames. Each method ticked on will be blended into the result.

- **Prev Forward**: Takes the previous frame and uses the Forward vector to interpolate the new frame.
- **Next Forward**: Takes the next frame in the sequence and uses the Forward vector to interpolate the new frame.
- **Prev Backward**: Takes the previous frame and uses the Back Forward vector to interpolate the new frame.
- **Next Backward**: Takes the next frame in the sequence and uses the Back vector to interpolate the new frame.

Common Controls

**Settings Tab**
The Settings tab in the Inspector is also duplicated in other miscellaneous nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.
The Time Stretcher node

**Time Stretcher Node Introduction**

The Time Stretcher node is similar to the Time Speed node but permits the speed of the clip to be animated. Full spline control of the effect is provided, including smoothing. As a result, the Time Stretcher can be used to animate a single clip to 200, back to normal speed, pause for a second, and then play backward (like a VCR rewinding).

Image interpolation offers smooth, high-quality results, all using a spline curve to adjust time nonlinearly. To apply constant time changes such as frame rate changes, use a Time Speed instead.

When operating in Flow mode, Optical Flow data is required. This node does not generate optical flow directly; you must create it manually upstream using an Optical Flow node or by loading the forward/reverse vector channels from disk.

Flow Stretcher does not interpolate the aux channels but instead destroys them. In particular, the Vector/BackVector channels are consumed/destroyed. Add an Optical Flow after the Flow Stretcher if you want to generate flow vectors for the retimed footage.

**Inputs**

The single input on the Time Stretcher node is used to connect a 2D image that will be time stretched.

- **Input**: The orange input is used for the primary 2D image that will be time stretched.

**Basic Node Setup**

Like the Time Speed node, the Time Stretcher setup is as simple as connecting a 2D image into the orange background input of the node.

![A MediaIn node having its time ramped to various speeds in the Time Stretcher node.](image)

**Inspector**

The Time Stretcher controls...
Source Time
This control designates from which frame in the original sequence to begin sampling.
When a Time Stretcher node is added to the node tree, the Source Time control already contains a Bézier spline with a single keyframe set to 0.0. The keyframe position is determined by the current time when the node is added to the node tree.

**NOTE:** The Source Time spline may not be immediately visible until Edit is selected from the Source Time’s contextual menu, or Display all Splines is selected from the Spline Window’s contextual menu.

Interpolate Mode
This menu determines how the time speed is processed in order to improve its visual playback quality, especially in the case of clips that are slowed down. There are three choices in the menu.

- **Nearest:** The most processor efficient and least sophisticated method of processing; frames are either dropped for fast motion or duplicated for slow motion.
- **Blend:** Also processor efficient but can produce smoother results; adjacent duplicated frames are dissolved together to smooth out slow or fast motion effects.
- **Flow:** The most processor intensive but highest quality method of speed effect processing. Using vector channels pre-generated from an Optical Flow node, new frames are generated to create slow or fast motion effects. The result can be exceptionally smooth when motion in a clip is linear. However, two moving elements crossing in different directions or unpredictable camera movement can cause unwanted artifacts.

Sample Spread
This slider is displayed only when Interpolation is set to Blend. The slider controls the strength of the interpolated frames on the current frame. A value of 0.5 blends 50% of the frame before and 50% of the frame ahead and 0% of the current frame.

Depth Ordering
This menu is displayed only when Interpolation is set to Flow. The Depth Ordering is used to determine which parts of the image should be rendered on top. This is best explained by example.

In a locked-off camera shot where a car is moving through the frame, the background does not move, so it produces small, or slow, vectors. The car produces larger, or faster, vectors.

The Depth Ordering in this case is Fastest on Top, since the car draws over the background.

In a shot where the camera pans to follow the car, the background has faster vectors, and the car has slower vectors, so the Depth ordering method would be Slowest on Top.

Clamp Edges
This checkbox is displayed only when Interpolation is set to Flow. Under certain circumstances, this option can remove the transparent gaps that may appear on the edges of interpolated frames. Clamp Edges can cause a stretching artifact near the edges of the frame that is especially visible with objects moving through it or when the camera is moving.

Because of these artifacts, it is a good idea to use clamp edges only to correct small gaps around the edges of an interpolated frame.

Edge Softness
This slider is displayed only when Interpolation is set to Flow and Clamp Edges is enabled. It helps to reduce the stretchy artifacts that might be introduced by Clamp Edges.
If you have more than one of the Source Frame and Warp Direction checkboxes turned on, this can lead to doubling up of the stretching effect near the edges. In this case, you’ll want to keep the softness rather small at around 0.01. If you have only one checkbox enabled, you can use a larger softness at around 0.03.

**Source Frame and Warp Direction**

These checkboxes are displayed only when Interpolation is set to Flow. These controls determine which frames and which vectors are used to create the in-between frames. Each method ticked on will be blended into the result.

- **Prev Forward**: Takes the previous frame and uses the Forward vector to interpolate the new frame.
- **Next Forward**: Takes the next frame in the sequence and uses the Forward vector to interpolate the new frame.
- **Prev Backward**: Takes the previous frame and uses the Back Forward vector to interpolate the new frame.
- **Next Backward**: Takes the next frame in the sequence and uses the Back vector to interpolate the new frame.

**Example**

Make sure that the current time is either the first or last frame of the clip to be affected in the project. Add the Time Stretcher node to the node tree. This will create a single point on the Source Time spline at the current frame. The value of the Source Time will be set to zero for the entire Global Range.

Set the value of the Source Time to the frame number to be displayed from the original source, at the frame in time it will be displayed in during the project.

To shrink a 100-frame sequence to 25 frames, follow these steps:

1. Change the Current Time to frame 0.
2. Change the Source Time control to 0.0.
3. Advance to frame 24.
5. Check that the spline result is linear.
6. Fusion will render 25 frames by interpolating down the 100 frames to a length of 25.
7. Hold the last frame for 30 frames, and then play the clip backward at regular speed. Continue the example from above and follow the steps below.
8. Advance to frame 129.
9. Right-click on the Source Time control and select Set Key from the menu.
10. Advance to frame 229 (129 + 100).
11. Set the Source time to 0.0.

**Common Controls**

**Settings Tab**

The Settings tab in the Inspector is also duplicated in other miscellaneous nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
Wireless Link Node Introduction

The Wireless Link node helps manage the tangle of connection lines in a node tree by wirelessly connecting one 2D node to another 2D node.

Although Wireless Links can be helpful, try to keep as much of a node tree as visible as possible; otherwise, you lose one of the main benefits of a node tree.

Inputs

There are no inputs on this node.

Basic Node Setup

There is no setup for this node. It is a free-standing node that connects “wirelessly” using the control in the Inspector.

Inspector

Controls Tab

The Controls tab in the Wireless Link node contains a single Input field for the linked node.

Input

To use the Wireless Link node, in the Node Editor, drag the 2D node into the Input field of the Wireless Link node. Any change you make to the original node is wirelessly replicated in the Wireless Link node. You can use the output from the Wireless Link node to connect to a nearby node.

Common Controls

Settings Tab

The Settings tab in the Inspector is also duplicated in other miscellaneous nodes. These common controls are described in detail in the following “The Common Controls” section.
The Common Controls

Nodes that handle miscellaneous operations share a number of identical controls in the Inspector. This section describes controls that are common among miscellaneous nodes.

Inspector

Settings Tab

The Settings tab in the Inspector can be found on every tool in the miscellaneous nodes. The controls are consistent and work the same way for each tool.

Blend

The Blend control is used to blend between the tool's original image input and the tool's final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming image. Normally, this will cause the tool to skip processing entirely, copying the input straight to the output.

Process When Blend Is 0.0

The tool is processed even when the input value is zero. This can be useful if processing of this node is scripted to trigger another task, but the value of the node is set to 0.0.
Red/Green/Blue/Alpha Channel Selector

These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.

For example, if the Red button on a Blur tool is deselected, the blur will first be applied to the image, and then the red channel from the original input will be copied back over the red channel of the result.

There are some exceptions, such as tools for which deselecting these channels causes the tool to skip processing that channel entirely. Tools that do this will generally possess a set of identical RGBA buttons on the Controls tab in the tool. In this case, the buttons in the Settings and the Controls tabs are identical.

Apply Mask Inverted

Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

Multiply by Mask

Selecting this option will cause the RGB values of the masked image to be multiplied by the mask channel's values. This will cause all pixels of the image not included in the mask (i.e., set to 0) to become black/transparent.

Use Object/Use Material (Checkboxes)

Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports Object ID and Material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels will be used, if present. The specific Material ID or Object ID affected is chosen using the next set of controls.

Correct Edges

This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option is disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information on Coverage and Background Color channels, see Chapter 18, “Understanding Image Channels” in the Fusion Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.

Object ID/Material ID (Sliders)

Use these sliders to select which ID will be used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker: to grab IDs from the image displayed in the view. The image or sequence must have been rendered from a 3D software package with those channels included.

Use GPU

The Use GPU menu has three settings. Setting the menu to Disable turns off GPU hardware-accelerated rendering. Enabled uses the GPU hardware for rendering the node. Auto uses a capable GPU if one is available and falls back to software rendering when a capable GPU is not available.
Motion Blur

- **Motion Blur**: This toggles the rendering of Motion Blur on the tool. When this control is toggled on, the tool’s predicted motion is used to produce the motion blur caused by the virtual camera’s shutter. When the control is toggled off, no motion blur is created.

- **Quality**: Quality determines the number of samples used to create the blur. A quality setting of 2 will cause Fusion to create two samples to either side of an object’s actual motion. Larger values produce smoother results but increase the render time.

- **Shutter Angle**: Shutter Angle controls the angle of the virtual shutter used to produce the motion blur effect. Larger angles create more blur but increase the render times. A value of 360 is the equivalent of having the shutter open for one whole frame exposure. Higher values are possible and can be used to create interesting effects.

- **Center Bias**: Center Bias modifies the position of the center of the motion blur. This allows for the creation of motion trail effects.

- **Sample Spread**: Adjusting this control modifies the weighting given to each sample. This affects the brightness of the samples.

Hide Incoming Connections

Enabling this checkbox can hide connection lines from incoming nodes, making a node tree appear cleaner and easier to read. When enabled, empty fields for each input on a node will be displayed in the Inspector. Dragging a connected node from the node tree into the field will hide that incoming connection line as long as the node is not selected in the node tree. When the node is selected in the node tree, the line will reappear.

Comments

The Comments field is used to add notes to a tool. Click in the empty field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

Scripts

Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
This chapter details the Optical Flow nodes available in Fusion.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

Optical Flow [OF] 2178
Repair Frame [Rep] 2181
Smooth Motion [SM] 2183
Tween [Tw] 2185
The Common Controls 2188
Optical Flow [OF]

Optical Flow Node Introduction
This node analyzes a clip connected to its input using an Optical Flow algorithm. Think of optical flow as a per-pixel motion vector that matches up features over several frames.

The computed optical flow is stored within the Vector and Back Vector aux channels of the output. These channels can be used in other nodes like the Vector Motion Blur or Vector Distort. However, Optical Flow must render twice when connecting it to a Time Stretcher or Time Speed node. These nodes require the channels A. FwdVec and B. BackVec in that order, but Optical Flow generates A. BackVec and A. FwdVec when it processes.

If you find that optical flow is too slow, consider rendering it out into OpenEXR files using a Saver node.

TIP: If the footage input flickers on a frame-by-frame basis, it is a good idea to deflicker the footage beforehand.

Inputs
The Optical Flow node includes a single orange image input.

– Input: The orange background input accepts a 2D image. This is the sequence of frames for which you want to compute optical flow. The output of the Optical Flow node includes the image and vector channels. The vector channels can be displayed by right-clicking in the viewer and choosing Channel > Vectors and then Options > Normalize Color Range.

Basic Node Setup
The Optical Flow node analyzes the frames connected to the background input. Trimming a Loader or MediaIn to only the range you need prevents analyzing unnecessary frames. The output of the node can then be connected to any node that takes advantage of vector channels, such as a Time Stretcher.

TIP: When analyzing Optical Flow vectors, consider adding a Smooth Motion node afterward with smoothing for forward/ backward vectors enabled.
Alternatively, if you find the Optical Flow node too slow to analyze the frames, consider rendering it out to an OpenEXR format using a Saver node. Then import the rendered EXR file as your new image with embedded vector channels.

![An Optical Flow node rendered out through a Saver node.](image)

### Inspector

![Optical Flow advanced controls](image)

### Controls Tab (Advanced)

When you add an Optical Flow, Repair Frame, or Tween node to a Comp, a Method drop-down menu in the Inspector allows you to choose between an Advanced GPU-based algorithm or a Classic CPU-based algorithm. This Advanced method is the same Optical Flow algorithm used in other DaVinci Resolve pages.

**Warp Count**

Decreasing this slider makes the optical flow computations faster. To understand what this option does, you must understand that the optical flow algorithm progressively warps one image until it matches with the other image. After some point, convergence is reached, and additional warps become a waste of computational time. You can tweak this value to speed up the computations, but it is good to watch what the optical flow is doing at the same time.

**Iteration Count**

Decreasing this slider makes the computations faster. In particular, just like adjusting the Warp Count, adjusting this option higher will eventually yield diminishing returns and not produce significantly better results. By default, this value is set to something that should converge for all possible shots and can be tweaked lower fairly often without reducing the disparity’s quality.

**Smoothness**

This controls the smoothness of the optical flow. Higher smoothness helps deal with noise, while lower smoothness brings out more detail.

**Half Resolution**

The Half Resolution checkbox is used purely to speed up the calculation of the optical flow. The input images are resized down and tracked to produce the optical flow.
Controls Tab (Classic)

By choosing Classic from the Method drop-down menu in the Inspector, you can use the older
CPU-based algorithm to maintain compatibility with Comps created in previous versions. This method
may also be better suited for some Stereo3D processing.

When using the Classic method, a single slider at the top of the Inspector improves performance by
generating proxies. The remaining Advanced section parameters tune the Optical Flow vector
calculations. The default settings serve as a good standard. In most cases, tweaking of the advanced
settings is not needed. Many deliver small or diminishing returns. However, depending on the settings,
rendering time can easily vary by 10x. If you're interested in reducing process time, it is best to start by
experimenting with the Proxy, Number of Iterations, and Number of Warps sliders and changing the
filtering to Bilinear.

Proxy (for Tracking)

The Proxy slider is used purely to speed up the calculation of the optical flow. The input images are
resized down by the proxy scale and tracked to produce the optical flow. The computational time is
roughly proportional to the number of pixels in the image. This means a proxy scale of 2 will give a
4x speedup, and a proxy scale of 3 will give a 9x speedup.

Smoothness

This controls the smoothness of the optical flow. Higher smoothness helps deal with noise, while lower
smoothness brings out more detail.

Edges

This slider is another control for smoothness but applies it based on the color channel. It tends to have
the effect of determining how edges in the flow follow edges in the color images. When it is set to a
low value, the optical flow becomes smoother and tends to overshoot edges. When it is set to a high
value, details from the color images start to slip into the optical flow, which is not desirable. Edges in
the flow end up more tightly aligning with the edges in the color images. This can result in streaked-
out edges when the optical flow is used for interpolation. As a rough guideline, if you are using the
disparity to produce a Z-channel for post effects like Depth of Field, then set it lower in value. If you are
using the disparity to perform interpolation, you might want it to be higher in value.

Match Weight

This control sets a threshold for how neighboring groups of foreground/background pixels are
matched over several frames. When set to a low value, large structural color features are matched.
When set to higher values, small sharp variations in the color are matched. Typically, a good value for
this slider is in the [0.7, 0.9] range. When dealing with stereo 3D, setting this option higher tends to
improve the matching results in the presence of differences due to smoothly varying shadows or local
lighting variations between the left and right images. The user should still perform a color match or
deflickering on the initial images, if necessary, so they are as similar as possible. This option also helps
with local variations like lighting differences due to light passing through a mirror rig.

Mismatch Penalty

This option controls how the penalty for mismatched regions grows as they become more dissimilar.
The slider provides a choice between a balance of Quadratic and Linear penalties. Quadratic strongly
penalizes large dissimilarities, while Linear is more robust to dissimilar matches. Moving this slider
toward Quadratic tends to give a disparity with more small random variations in it, while Linear
produces smoother, more visually pleasing results.

Warp Count

Decreasing this slider makes the optical flow computations faster. In particular, the computational time
depends linearly upon this option. To understand what this option does, you must understand that the
optical flow algorithm progressively warps one image until it matches with the other image. After some
point, convergence is reached, and additional warps become a waste of computational time. The
default value in Fusion is set high enough that convergence should always be reached. You can tweak
this value to speed up the computations, but it is good to watch what the optical flow is doing at the
same time.
**Iteration Count**
Decreasing this slider makes the computations faster. In particular, the computational time depends linearly upon this option. Just like adjusting the Warp Count, adjusting this option higher will eventually yield diminishing returns and not produce significantly better results. By default, this value is set to something that should converge for all possible shots and can be tweaked lower fairly often without reducing the disparity's quality.

**Filtering**
This option controls filtering operations used during flow generation. Catmull-Rom filtering will produce better results, but at the same time, turning on Catmull-Rom will increase the computation time steeply.

**Common Controls**

**Settings Tab**
The Settings tab in the Inspector is also duplicated in other Optical Flow nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

---

**Repair Frame [Rep]**

**Repair Frame Node Introduction**
Repair Frame replaces damaged or missing frames or portions of frames with scratches or other temporally transient artifacts. It requires three frames: the repair frame and two neighboring frames. An Optical Flow node is not required for generating motion vectors since the Repair Frame node computes the optical flow. However, this can make it slow to process.

Repair Frame will not pass through, but rather destroys, any aux channels after the computation is done.

See the Optical Flow node for controls and settings information.

**TIP:** If your footage varies in color from frame to frame, sometimes the repair can be noticeable because, to fill in the hole, Repair Frame must pull color values from adjacent frames. Consider using deflickering, color correction, or using a soft-edged mask to help reduce these kinds of artifacts.

**Inputs**
There are two inputs on the Repair Frame node. One is used to connect a 2D image that will be repaired and the other is for an effect mask.

- **Input:** The orange input is used for the primary 2D image that will be repaired.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the repairs to certain areas.
Basic Node Setup

The Repair Frame node analyzes the incoming MediaIn node and repairs single frame issues like dust or scratches.

![A Repair Frame node set up to analyze a MediaIn node using internal optical flow analysis.](image)

Inspector

The Controls tab includes options for how to repair the frames. It also includes controls for adjusting the optical flow analysis, identical to those controls in the Optical Flow node.

**Controls Tab**

The Controls tab includes options for how to repair the frames. It also includes controls for adjusting the optical flow analysis, identical to those controls in the Optical Flow node.

**Depth Ordering**

The Depth Ordering determines which parts of the image should be rendered on top by selecting either Fastest On Top or Slowest On Top. The examples below best explain these options.

In a locked-off camera shot where a car is moving through the frame, the background does not move, so it produces small, or slow, vectors, while the car produces larger, or faster, vectors. The depth ordering in this case is Fastest On Top since the car draws over the background.

In a shot where the camera pans to follow the car, the background has faster vectors, and the car has slower vectors, so the Depth Ordering method is Slowest On Top.

**Clamp Edges**

Under certain circumstances, this option can remove the transparent gaps that may appear on the edges of interpolated frames. Clamp Edges causes a stretching artifact near the edges of the frame that is especially visible with objects moving through it or when the camera is moving.

Because of these artifacts, it is a good idea to use clamp edges only to correct small gaps around the edges of an interpolated frame.
**Edge Softness**
This slider is displayed only when Clamp Edges is enabled. The slider helps to reduce the stretchy artifacts that might be introduced by Clamp Edges.

If you have more than one of the Source Frame and Warp Direction checkboxes turned on, this can lead to doubling up of the stretching effect near the edges. In this case, you'll want to keep the softness rather small at around 0.01. If you have only one checkbox enabled, you can use a larger softness at around 0.03.

**Source Frame and Warp Direction**
These checkboxes allow you to choose which frames and vectors create the in-between frames. Each method ticked on will be blended into the result.

- **Prev Forward**: Takes the previous frame and uses the Forward vector to interpolate the new frame.
- **Next Forward**: Takes the next frame in the sequence and uses the Forward vector to interpolate the new frame.
- **Prev Backward**: Takes the previous frame and uses the Back Forward vector to interpolate the new frame.
- **Next Backward**: Takes the next frame in the sequence and uses the Back vector to interpolate the new frame.

**Optical Flow Options**
These settings tweak the optical flow analysis. See the Classic and Advanced Controls section for the Optical Flow node earlier in this chapter.

**Common Controls**

**Settings Tab**
The Settings tab in the Inspector is also duplicated in other Optical Flow nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

---

**Smooth Motion [SM]**

The Smooth Motion node smoothes various AOV (Arbitrary Output Variables) channels in a clip using optical flow to look at neighboring frames. It can be used for smoothing the Disparity channel in a stereo 3D clip, where it helps reduce temporal edge/fringing artifacts, but it can also smooth a wide range of channels like vectors, normals, and Z.

It is required that the image connected to the input on the node have precomputed Vector and Back Vector channels; otherwise, this tool prints error messages in the Console window.

Check on the channels you want to temporally smooth. Be aware that if a channel selected for smoothing is not present, Smooth Motion will not fail, nor will it print any error messages.
It can also be used to smooth the Vector and Back Vector channels; however, sometimes, this can make the interpolated results worse if there are conflicting motions or objects in the shot that move around erratically, jitter, or bounce rapidly.

**TIP:** You can use two or more Smooth Motion nodes in sequence to get additional smoothing. With one Smooth Motion node, the previous, current, and next frames are examined for a total of 3; with two Smooth Motion nodes, 5 frames are examined; and with three Smooth Motion nodes, 7 frames are examined.

Another technique using two Smooth Motion nodes is to use the first Smooth Motion node to smooth the Vector and Back Vector channels. Use the second Smooth Motion to smooth the channels you want to smooth (e.g., Disparity). This way, you use the smoothed vector channels to smooth Disparity.

You can also try using the smoothed motion channels to smooth the motion channels.

**Inputs**

The Smooth Motion node includes a single orange image input.

- **Input:** The orange image input accepts a 2D image. This is the sequence of images for which you want to compute smooth motion. This image must have precomputed Vector and Back Vector channels either generated from an Optical Flow node or saved in EXR format with vector channels.

**Basic Node Setup**

The Smooth Motion node takes the output of the Optical Flow node for the required Vector and Back Vector channels. The Smooth Motion node can then be used to smooth those channels or AO channels.

A Smooth Motion node using Vector and Back Vector channels from the Optical Flow node.

**Inspector**

The Smooth Motion Controls tab
Controls Tab

The Controls tab includes checkboxes for the channels you want to smooth. If a channel selected for smoothing is not available in the input image, Smooth Motion will not fail, nor will it print any error messages to the Console.

Channel

Smooth Motion can be applied to more than just the RGBA channels. It can also be applied to the other AOV channels.

Common Controls

Settings Tab

The Settings tab in the Inspector is also duplicated in other Optical Flow nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

Tween [Tw]

The Tween node

Tween Node Introduction

Tween reconstructs a missing frame by interpolating between two neighboring frames using the optical flow. Tween is nearly identical in functionality to Time Speed and Time Stretcher. The major difference is that it works on two images that are not serial members of a sequence. As a consequence, it cannot use the Vector or Back Vector aux channels stored in the images. The Tween node manually generates the optical flow, so there is no need to add an Optical Flow node before the Tween node. The generated optical flow is thrown away and is not stored back into the output frames.

Since optical flow is based on color matching, it is a good idea to color correct your images to match ahead of time. Also, if you are having trouble with noisy images, it may also help to remove some of the noise ahead of time.

Tween destroys any input aux channels. See the Optical Flow node for controls and settings information.

Inputs

There are two image inputs on the Tween node and an effects mask input.

– **Input 0**: The orange input, labeled input 0, is the previous frame to the one you are generating.

– **Input 1**: The green input, labeled input 1, is the next frame after the one you are generating.

– **Effect Mask**: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the Tween to certain areas.
**Basic Node Setup**

The Tween node receives two inputs for the two neighboring frames to the one you are generating. Below, the previous frame, frame 01, is connected to the orange input 0. The next frame, frame 03, is connected to the green input 1. The Tween node will generate frame 02 and output the sequence.

![Tween node setup](image)

The Tween node receives two neighboring frames and generates the middle one.

**Inspector**

**Controls Tab**

The Controls tab includes options for how to tween frames. It also includes controls for adjusting the optical flow analysis, identical to those controls in the Optical Flow node.

**Interpolation Parameter**

This option determines where the frame you are interpolating is, relative to the two source frames A and B. An Interpolation Parameter of 0.0 will result in frame A, a parameter of 1.0 will result in frame B, and a parameter of 0.5 will yield a result halfway between A and B.

**Depth Ordering**

The Depth Ordering determines which parts of the image should be rendered on top by selecting either Fastest On Top or Slowest On Top. The examples below best explain these options.

In a locked-off camera shot where a car is moving through the frame, the background does not move, so it produces small, or slow, vectors, while the car produces larger, or faster, vectors.
The Depth Ordering in this case is Fastest On Top since the car draws over the background.

In a shot where the camera pans to follow the car, the background has faster vectors, and the car has slower vectors, so the Depth Ordering method is Slowest On Top.

**Clamp Edges**

Under certain circumstances, this option can remove the transparent gaps that may appear on the edges of interpolated frames. Clamp Edges causes a stretching artifact near the edges of the frame that is especially visible with objects moving through it or when the camera is moving.

Because of these artifacts, it is a good idea to use Clamp Edges only to correct small gaps around the edges of an interpolated frame.

**Edge Softness**

This slider is displayed only when Clamp Edges is enabled. The slider helps to reduce the stretchy artifacts that might be introduced by Clamp Edges.

If you have more than one of the Source Frame and Warp Direction checkboxes turned on, this can lead to doubling up of the stretching effect near the edges. In this case, you’ll want to keep the softness rather small at around 0.01. If you have only one checkbox enabled, you can use a larger softness at around 0.03.

**Source Frame and Warp Direction**

These checkboxes allow you to choose which frames and vectors create the in-between frames. Each method ticked on will be blended into the result.

- **Prev Forward**: Takes the previous frame and uses the Forward vector to interpolate the new frame.
- **Next Forward**: Takes the next frame in the sequence and uses the Forward vector to interpolate the new frame.
- **Prev Backward**: Takes the previous frame and uses the Back Forward vector to interpolate the new frame.
- **Next Backward**: Takes the next frame in the sequence and uses the Back vector to interpolate the new frame.

**Optical Flow Options**

These settings tweak the optical flow analysis. See the Class and Advanced Controls section for the Optical Flow node earlier in this chapter.

**Common Controls**

**Settings Tab**

The Settings tab in the Inspector is also duplicated in other Optical Flow nodes. These common controls are described in detail in the following “The Common Controls” section.
The Common Controls

Nodes that handle optical flow operations share a number of identical controls in the Inspector. This section describes controls that are common among Optical Flow nodes.

Inspector

Settings Tab

The Settings tab in the Inspector can be found on every tool in the Optical Flow category. The controls are consistent and work the same way for each tool.

**Blend**

The Blend control is used to blend between the tool’s original image input and the tool’s final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming image. Normally, this causes the tool to skip processing entirely, copying the input straight to the output.

**Process When Blend Is 0.0**

The tool is processed even when the input value is zero. This can be useful when this node process is scripted to trigger another task, but the value of the node is set to 0.0.

**Red/Green/Blue/Alpha Channel Selector**

These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.

For example, if the Red button on a Blur tool is deselected, the blur is first applied to the image, and then the red channel from the original input will be copied back over the red channel of the result.
There are some exceptions, such as tools for which deselecting these channels causes the tool to skip processing that channel entirely. Tools that do this generally possess a set of identical RGBA buttons on the Controls tab in the tool. In this case, the buttons in the Settings and the Controls tabs are identical.

**Apply Mask Inverted**
Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

**Multiply by Mask**
Selecting this option causes the RGB values of the masked image to be multiplied by the mask channel’s values. This causes all pixels of the image not included in the mask (i.e., set to 0) to become black/transparent.

**Use Object/Use Material (Checkboxes)**
Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports Object ID and Material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels are used, if present. The specific Material ID or Object ID affected is chosen using the next set of controls.

**Correct Edges**
This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information on the Coverage and Background Color channels, see Chapter 18, “Understanding Image Channels” in the Fusion Studio Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.

**Object ID/Material ID (Sliders)**
Use these sliders to select which ID is used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker: to grab IDs from the image displayed in the view. The image or sequence must have been rendered from a 3D software package with those channels included.

**Hide Incoming Connections**
Enabling this checkbox can hide connection lines from incoming nodes, making a node tree appear cleaner and easier to read. When enabled, empty fields for each input on a node are displayed in the Inspector. Dragging a connected node from the node tree into the empty field hides that incoming connection line as long as the node is not selected in the node tree. When the node is selected in the node tree, the line reappears.

**Comments**
The Comments field is used to add notes to a tool. Click in the empty field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

**Scripts**
Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, see the Fusion scripting documentation.
This chapter details the Paint node available in Fusion.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paint</td>
<td>2191</td>
</tr>
<tr>
<td>Paint Node Modifiers</td>
<td>2197</td>
</tr>
<tr>
<td>Keyboard Shortcuts</td>
<td>2198</td>
</tr>
</tbody>
</table>
Paint

Paint Node Introduction

Paint is an extremely flexible, stroke-based tool for wire and rig removal, image cloning, or to create custom masks and mattes rapidly. Fusion's paint can even be used to create new images and artistic elements from scratch.

Each Paint node is made up of a series of brush strokes. These strokes are vector shapes with editable brush, size, and effect. A wide range of apply modes and brush types are available.

Most Brushstrokes styles are editable polylines for fine control. They can be animated to change shape, length, and size over time. The opacity and size of a stroke can be affected by velocity and pressure when used with a supported tablet.

Unlimited undo and redo of paint provides the ability to experiment before committing changes to an image sequence. Paint strokes can be reordered, deleted, and modified with virtually infinite flexibility.

Inputs

The two inputs on the Paint node are used to connect a 2D image and an effect mask which can be used to limit the painted area.

– **Input:** It is required to connect the orange input with a 2D image that creates the size of the "canvas" on which you paint.

– **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the Paint to only those pixels within the mask.

Basic Node Setup

The Paint node always needs an input connection. The simplest setup is to paint directly on the incoming MediaIn node.

A MediaIn node connected directly to the Paint input

A more flexible setup is to use a Background node to set the size that matches the image you are painting on. In the Inspector, the background would be set to be fully transparent. Then, the Paint tool can be merged as the foreground over the actual image you want to paint on.
Types of Paint Strokes

To begin working with the Paint tool, first select the paint stroke type from the Paint toolbar above the viewer. There are ten stroke types to choose from as well as two additional tools for selecting and grouping paint strokes. The stroke types and tools are described below in the order they appear in the toolbar.

- **Multistroke**: Although this is the default selection and the first actual brush type in the toolbar, Multistroke is not typically the stroke type most often used. However, it’s perfect for those 100-strokes-per-frame retouching paint jobs like removing tracking markers. Multistroke is much faster than the Stroke type but is not editable after it is created. By default, Multistroke lasts for one frame and cannot be modified after it has been painted. Use the Duration setting in the Stroke controls to set the number of frames before painting. A shaded area of the Multistroke duration is visible but not editable in the Keyframes Editor. While Multistrokes aren’t directly editable, they can be grouped with the PaintGroup modifier, then tracked, moved, and rotated by animating the PaintGroup instead.

- **Clone Multistroke**: Similar to Multistroke but specifically meant to clone elements from one area or image to the other. Perfect for those 100-strokes-per-frame retouching paint jobs like removing tracking markers. Clone Multistroke is faster than the Stroke type but is not editable after it is created. By default, Clone Multistroke lasts for one frame and cannot be modified after it has been painted. Use the Duration setting in the Stroke controls to set the number of frames before painting. A shaded area of the Clone Multistroke duration is visible but not editable in the Keyframes Editor.

- **Stroke**: In most cases, the Stroke tool is what people think of when they think of paint and is the tool of choice for most operations. It is a fully animatable and editable vector-based paint stroke. It can become slow if hundreds of strokes are used in an image; when creating a lot of paint strokes, it is better to use Multistroke. The Stroke type has a duration of the entire global range. However, you can edit its duration at any time in the Keyframes Editor. When the painting is complete, choose the Select button in the Paint toolbar to avoid accidentally adding new strokes.

- **Polyline Stroke**: This provides the ability to create and manipulate a stroke in the same way that a Bézier path or polygon mask might be created. To add a Polyline Stroke, select the Polyline button and click in the viewer to add the first point. Continue clicking to add additional points to the polyline. This click append style is the default, but polyline strokes can also be created in draw append mode. Polylines can be tracked or connected to existing polylines like masks or animation paths. The Polyline Stroke has a default duration of the entire global range. However, you can edit its duration at any time in the Keyframes Editor.
– **Circle**: Creates a circular shape with animatable control over radius and center. The Circle type has a duration of the entire global range. However, you can edit its duration at any time in the Keyframes Editor.

– **Rectangle**: Creates a rectangular area. The Rectangle type has a duration of the entire global range. However, you can edit its duration at anytime in the Keyframes Editor.

– **Copy Polyline**: Allows you to create a closed Polyline area with animatable offset to clone elements from one area or image to the other. The Copy Polyline type has a duration of the entire global range. However, you can edit its duration at any time in the Keyframes Editor.

– **Copy Circle/Rectangle**: A circular or rectangular shape area with animatable offset to clone elements from one image to the other. The Copy Circle/Rectangle type has a duration of the entire global range. However, you can edit its duration at any time in the Keyframes Editor.

– **Fill**: Similar to the Wand mask tool. This tool fills similarly colored adjacent pixels with a fill color based on the selected color channel. The tool has a duration of the entire global range. However, you can edit its duration at any time in the Keyframes Editor.

– **Paint Group**: Allows you to group multiple paint strokes with full control over center and size. Since Multistroke and Clone Multistroke styles cannot be tracked, grouping these paint stroke types and tracking the paint group is one common use of groups.

### Editing Options Toolbar

![Editing Options Toolbar Image](image)

Paint edit options are displayed in the viewer after a Polyline stroke is created.

Polyline-based paint strokes include a second toolbar in the viewer to select different editing options. The paint strokes that include this second toolbar are Polyline Stroke and Copy Polyline. The Stroke style also displays this toolbar after the stroke is selected and the Make Editable button is clicked in the Inspector.

– **Click Append**: This is the default option when creating a polyline stroke. It works more like a Bézier pen drawing tool than a paintbrush tool. Clicking sets a control point and appends the next control point when you click again in a different location.

– **Draw Append**: This is a freehand drawing tool. It paints a stroke similar to drawing with a pencil on paper. You can create a new Polyline Stroke or Copy Polyline Stroke using the Draw tool, or you can extend a Stroke style after clicking the Make Editable button in the Inspector.

– **Insert**: Insert adds a new control point along the paint stroke spline.

– **Modify**: Modify allows you to safely move or smooth any exiting point along a spline without worrying about adding a new point accidentally.

– **Done**: Prevents any point along the spline from being moved or modified. Also, new points cannot be added. You can, however, move and rotate the entire spline.

– **Closed**: Closes an open polyline.

– **Smooth**: Changes the selected stroke or control point from a linear to a smooth curve.

– **Linear**: Changes the selected stroke or control point from a smooth curve to linear.

– **Select All**: Selects all the control points on the polyline.
– **Keys:** Shows or hides the control points along the polyline.

– **Handles:** Shows or hides the Bézier handles along the polyline.

– **Shape:** Places a reshape rectangle around the selected polyline control points. Using the reshape rectangle, you can deform groups of polyline control points or entire shapes much easier than modifying each point.

– **Delete:** Deletes the selected control point(s).

– **Reduce:** Opens a Freehand precision window that can be used to reduce the number of control points on a polyline. This can make the paint stroke easier to modify, especially if it has been created using the Draw tool.

– **Publish:** You can use the Publish menu to either publish control points or the path. Publishing is a form of parameter linking. It makes the selected item available for use by other controls, or to attach a control point to a tracker.

– **Follow Points:** Allows a selected point to follow the path of a published point. The point follows the published point using an offset position.

– **Roto Assist:** Enable the Roto Assist button when you begin painting with the Polyline Stroke tool. The polyline points snap to the closest edge as you click to add points to the shape. A cyan outline indicates the points that have snapped to an edge. There are three main Roto Assist options selectable through the drop-down menu:

  – **Multiple Points:** When enabled, a single click on a high-contrast edge will add multiple points to define the entire edge, instead of having to add each point individually. This is a one time only click. The second click reverts to single point edge detection.

  – **Distance 8:** Opens a dialog where you can set the pixel range within which searching for an edge will take place.

  – **Reset:** Used for resetting the snap attribute of all snapped points. After resetting, the points will become unavailable for tracking.

**Inspector**

![The Paint Controls tab](image)

Chapter 112  Paint Node  2194
Controls Tab

Not all of the controls described here appear in all modes. Some controls are useful only in a specific Paint mode and do not appear when they are not applicable. The Controls tab is used to configure your paint settings before painting. Once a paint stroke is created, except for the Multistroke and Clone Multistroke, you can select the stroke in the viewer and update the controls.

Brush Controls

**Brush Shape**

The brush shape buttons select the brush tip shape. Except for the single pixel shape, you can modify the size of the brush shape in the viewer by holding down the Command or Ctrl key while dragging the mouse.

- **Soft Brush**: The Soft Brush type is a circular brush tip with soft edges.
- **Circular Brush**: A Circular Brush is a brush tip shape with hard edges.
- **Image Brush**: The Image Brush allows images from any node in the node tree, or from a file system, to be used as a brush tip.
- **Single Pixel Brush**: The Single Pixel Brush is perfect for fine detail work, creating a brush tip precisely one pixel in size. No anti-aliasing is applied to the single pixel brush.
- **Square Brush**: A Square Brush is a brush tip with hard edges.

**Vary Size**

Vary size settings change the stroke size based on speed or a pressure-sensitive pen and tablet.

- **Constant**: The brush tip remains a constant size over the stroke.
- **With Pressure**: The stroke size varies with the actual applied pressure.
- **With Velocity**: The stroke size varies with the speed of painting. The faster the stroke, the thinner it is.

**Vary Opacity**

Vary opacity settings change the stroke opacity based on speed or a pressure-sensitive pen and tablet.

- **Constant**: The brush tip remains at a constant transparency setting over the entire stroke.
- **With Pressure**: The stroke transparency varies with the applied pressure.
- **With Velocity**: The stroke transparency varies with the speed of painting. The faster the stroke, the more transparent it is.

**Softness**

Use this control to increase or decrease the Softness of a soft brush.

**Image Source**

When using the Image Source brush type, select between three possible source brush images.

- **Node**: The image source is derived from the output of a node in the node tree. Drag the node into the Inspector’s Source node input field to set the source.
- **Clip**: The image source is derived from an image or sequence on disk. Any file supported by Fusion’s Loader or MediaIn node can be used.
- **Brush**: Select an image to use as a brush from the menu. Images located in the Fusion > Brushes directory are used to populate the menu.
**Color Space**

When the Fill tool is selected, a Color Space menu selects the color space when sampling colors around the Fill tool center for inclusion in the fill range.

**Channel**

When the Fill tool is selected, a Channel menu selects which color channel is used in the fill paint. For example, with alpha selected, the fill occurs on contiguous pixels of the alpha channel.

**Apply Controls**

**Apply Mode**

The Apply Modes are buttons that change a brush's painting functionality.

- **Color**: The Color Apply Mode paints simple colored strokes. When used in conjunction with an image brush, it can also be used to tint the image.

- **Clone**: The Clone Apply Mode copies an area from the same image using adjustable positions and time offsets. This mode can also copy portions of one image into another image. Any image from the node tree can be used as the source image.

- **Emboss**: The Emboss Apply Mode embosses the portions of the image covered by the brush stroke.

- **Erase**: Erase reveals the underlying image through all other strokes, effectively erasing portions of the strokes beneath it without actually destroying the strokes.

- **Merge**: This Apply Mode effectively merges the brush onto the image. This mode behaves in much the same way as the Color Apply Mode but has no color controls. It is best suited for use with the image brush type.

- **Smear**: Smear the image using the direction and strength of the brushstroke as a guide.

- **Stamp**: Stamps the brush onto the image, completely ignoring any alpha channel or transparency information. This mode is best suited for applying decals to the target image.

- **Wire**: This Wire Removal Mode is used to remove wires, rigging, and other small elements in the frame by sampling adjacent pixels and draw them in toward the stroke.

**Stroke Controls**

The stroke controls contain parameters that adjust the entire stroke of paint as well as control it over time.

- **Size**: This control adjusts the size of the brush when the brush type is set to either Soft Brush or Circle. The diameter of the brush is drawn in the viewer as a small circle surrounding the mouse pointer. The size can also be adjusted interactively in the viewer by holding the Command or Ctrl key while dragging the mouse pointer.

- **Spacing**: The Spacing slider determines the distance between dabs (samples used to draw a continuous stroke along the underlying vector shape). Increasing this value increases the density of the stroke, whereas decreasing this value causes the stroke to assume the appearance of a dotted line.

- **Stroke Animation**: The Stroke Animation menu provides several pre-built animation effects that can be applied to a paint stroke. This menu appears only for vector strokes like Stroke and Polyline Stroke.
  - **All Frames**: This default displays the stroke for all frames of the image connected to the orange background input of the Paint node.
  - **Limited Duration**: This exists on the number of frames specified by the Duration slider.
– **Write On**: When Write On is selected, an animation spline is added to the paint stroke that precisely duplicates the timing of the paint stroke’s creation. The stroke is written on the image exactly as it was drawn. To adjust the timing of the Write On effect, switch to the Spline Editor and use the Time Stretcher node to adjust the overall length of the animation spline. To smooth or manually adjust the motion, try reducing the points in the animation spline.

– **Write Off**: Write Off performs the reverse of Write On, drawing the stroke starting from the end and working backward to the start of the stroke.

– **Write On Then Off**: This menu option applies a Write On and then a Write Off animation mode to the stroke.

– **Trail**: Selecting the Trail option from the menu causes both the start and end points of the stroke to be animated simultaneously, offset from each other by the amount specified in the Duration control. This has the effect of creating a painted segment that follows the stroke path. As with the Write On and Write Off effects, this starts on the current frame when the animation mode is selected. The timing of the animation can be adjusted manually using the Spline or Keyframes Editors.

– **Duration**: Duration sets the duration of each stroke in frames. This control is present only for Multistroke and Clone Multistroke, or when the stroke animation mode is set to Limited Duration. It is most commonly employed for frame-by-frame rotoscoping through a scene. Each Vector stroke applied to a scene has a duration in the Keyframes Editor that can be trimmed independently from one stroke to the next. The duration can be set to 0.5, which allows each stroke to last for a single field only when the node tree is processing in Fields mode.

– **Write On and Write Off**: This range slider appears when the Stroke Animation is set to one of the Write On and Write Off methods. The range represents the beginning and end points of the stroke. Increase the Start value from 0.0 to 1.0 to erase the stroke, or increase the End value from 0.0 to 1.0 to draw the stroke on the screen. This control can be animated to good effect. It works most effectively when automatically animated through the use of the Write On and Write Off modes of the Stroke Animation menu.

– **Make Editable**: This button appears only for Vector strokes. Clicking on Make Editable turns the current stroke into a polyline spline so that the shape can be adjusted or animated.

### Paint Node Modifiers

Every paint stroke created in the viewer creates an associated modifier stroke. These modifier strokes are represented as a list of paint stroke operations in the Modifiers tab of the Inspector. Each stroke you create can be modified or deleted, or applied in a different order using the modifier stack.

**NOTE**: The MultiStroke tools are built for speed and can contain many strokes internally without creating a huge list stack in the modifiers

Each Paint modifier stroke contains Brush controls, Apply controls, and Stroke controls identical to those found in the main Controls tab of the Inspector.
Keyboard Shortcuts

Keyboard shortcuts allow you to adjust painting styles and color without having to navigate menus.

| **While painting:** | Hold Command or Ctrl while left-dragging to change brush size.  
                    | Hold Option or Alt while clicking to pick a color in the viewer. |
|--------------------|---------------------------------------------------------------|

| **While cloning:** | Option-click or Alt-click to set the clone source position. Strokes start cloning from the selected location.  
                   | Hold O to temporarily enable a 50% transparent overlay of the clone source (% can be changed with pref Tweaks.CloneOverlayBlend).  
                   | Press P to toggle an opaque overlay of the clone source. |
|--------------------|-------------------------------------------------------------------|

| **While overlay is showing:** | Arrow keys change the clone source position; you can also drag crosshairs and adjust angle control or size sliders.  
                              | Option + Left/Right or Alt + Left/Right Arrow keys change the clone source angle.  
                              | Option + Up/Down or Alt + Up/Down Arrow keys change the clone source size.  
                              | Shift + Command or Shift + Ctrl can be used with the above for greater or lesser adjustments. Left and right square brackets, [ and ], change the clone source Time Offset (this requires a specific Clone Source node to be set in the Source Node field). |
|-----------------------------|-------------------------------------------------------------------|

<table>
<thead>
<tr>
<th><strong>Copy Rect/Ellipse:</strong></th>
<th>Shift + drag out the source to constrain the shape.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>With a single stroke selected (not available on multi or polyline strokes):</strong></th>
<th>Press X or Y to flip the stroke.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Paint Groups:</strong></th>
<th>Command + drag or Ctrl + drag to change the position of a group’s crosshair, without changing the position of the group.</th>
</tr>
</thead>
</table>
Chapter 113

Particle Nodes

This chapter details the Particle nodes available in Fusion.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

<table>
<thead>
<tr>
<th>Particle Nodes</th>
<th>Page</th>
<th>Notes</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>pCustom [pCu]</td>
<td>2204</td>
<td>pMerge [pMg]</td>
<td>2229</td>
</tr>
<tr>
<td>pDirectionalForce [pDF]</td>
<td>2210</td>
<td>pRender [pRn]</td>
<td>2231</td>
</tr>
<tr>
<td>pFollow [pFo]</td>
<td>2218</td>
<td>pTurbulence [pTr]</td>
<td>2241</td>
</tr>
<tr>
<td></td>
<td>2222</td>
<td>The Common Controls</td>
<td>2244</td>
</tr>
</tbody>
</table>
Particle Nodes

The Particle nodes are used to generate a large number of duplicated objects that automatically animate. They are used to create elements like falling rain, fireworks, smoke, pixie dust, and much more. There are endless possibilities. Particles in Fusion consist of a set of nodes that are strung together in a chain for generating, modifying, and rendering particles in a 2D or 3D scene.

To begin, every particle system you create must contain two fundamental nodes:

- **pEmitter**: Used to generate the particles and control their basic look, motion, and behavior.
- **pRender**: Used to render the output of the pEmitter into a 2D or 3D scene. When creating particles, you only ever view the pRender node.

The remaining particle nodes modify the pEmitter results to simulate natural phenomena like gravity, flocking, and bounce. The names of particle nodes all begin with a lowercase `p` to differentiate them from non-particle nodes. They can be found in the particles category in the Effects Library.

**pAvoid [pAv]**

The pAvoid node

**pAvoid Node Introduction**

The pAvoid node is used to create a region or area within the image that affected particles attempt to avoid entering and crossing.

It has two primary controls. The first determines the distance from the region a particle should be before it begins to move away from the region. The second determines how strongly the particle moves away from the region.

A pAvoid node creates a “desire” in a particle to move away from a specific region. If the velocity of the particle is stronger than the combined distance and strength of the pAvoid region, the particle’s desire to avoid the region does not overcome its momentum and the particle crosses that region regardless.
Inputs
The pAvoid node has a single orange input by default. Like most particle nodes, this orange input accepts only other particle nodes. A green bitmap or mesh input appears on the node when you set the Region menu in the Region tab to either Bitmap or Mesh.

- **Input**: The orange input takes the output of other particle nodes.
- **Region**: The green or magenta region input takes a 2D image or a 3D mesh depending on whether you set the Region menu to Bitmap or Mesh. The color of the input is determined by whichever is selected first in the menu. The 3D mesh or a selectable channel from the bitmap defines the area particles avoid.

Basic Node Setup
The pAvoid node is placed in between the pEmitter and pRender. A Shape 3D node is used to create the region the particles will avoid.

![A pAvoid node using a Shape 3D node as the region to avoid](image)

Inspector
The pAvoid controls

**Randomize**
The Random Seed slider and Randomize button are presented whenever a Fusion node relies on a random result. Two nodes with the same seed values will produce the same random results. Click the Randomize button to randomly select a new seed value, or adjust the slider to manually select a new seed value.

**Distance**
Determines the distance from the region a particle should be before it begins to move away from the region.

**Strength**
Determines how strongly the particle moves away from the region. Negative values make the particles move toward the region instead.
Common Controls

**Conditions, Style, Region, and Settings Tabs**
The Conditions, Style, Region, and Settings tabs are common to all Particle nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.

**pBounce [pBn]**

The pBounce tool is used to create a region from which affected particles will bounce off when they come into contact.

**Inputs**
The pBounce node has a single orange input by default. Like most particle nodes, this orange input accepts only other particle nodes. A green or magenta bitmap or mesh input appears on the node when you set the Region menu in the Region tab to either Bitmap or Mesh.

- **Input**: The orange input takes the output of other particle nodes.
- **Region**: The green or magenta region input takes a 2D image or a 3D mesh depending on whether you set the Region menu to Bitmap or Mesh. The color of the input is determined by whichever is selected first in the menu. The 3D mesh or a selectable channel from the bitmap defines the area particles bounce off.

**Basic Node Setup**
The pBounce node is placed in between the pEmitter and pRender. A Shape 3D node is used to create the region the particles bounce off.

A pBounce node using a Shape 3D node as the region on which particles bounce off
Randomize
The Random Seed slider and Randomize button are presented whenever a Fusion node relies on a random result.
Two nodes with the same seed values will produce the same random results. Click the Randomize button to randomly select a new seed value, or adjust the slider to manually select a new seed value.

Elasticity
Elasticity affects the strength of a bounce, or how much velocity the particle will have remaining after impacting upon the Bounce region. A value of 1.0 will cause the particle to possess the same velocity after the bounce as it had entering the bounce. A value of 0.1 will cause the particle to lose 90% of its velocity upon bouncing off of the region.
The range of this control is 0.0 to 1.0 by default, but greater values can be entered manually. This will cause the particles to gain momentum after an impact, rather than lose it. Negative values will be accepted but do not produce a useful result.

Variance
By default, particles that strike the Bounce region will reflect evenly off the edge of the Bounce region, according to the vector or angle of the region. Increasing the Variance above 0.0 will introduce a degree of variation to that angle of reflection. This can be used to simulate the effect of a rougher surface.

Spin
By default, particles that strike the region will not have their angle or orientation affected in any way. Increasing or decreasing the Spin value will cause the Bounce region to impart a spin to the particle based on the angle of collision, or to modify any existing spin on the particle. Positive values will impart a forward spin, and negative values impart a backward spin. The larger the value, the faster the spin applied to the particle will be.

Roughness
This slider varies the bounce off the surface to slightly randomize particle direction.

Surface Motion
This slider makes the bounce surface behave as if it had motion, thus affecting the particles.

Surface Motion Direction
This thumbwheel control sets the angle relative to the bounce surface.
Common Controls

Conditions, Style, Region, and Settings Tabs
The Conditions, Style, Region, and Settings tabs are common to all Particle nodes, so their descriptions can be found in "The Common Controls" section at the end of this chapter.

pChangeStyle [pCS]

The pChange Style node provides a mechanism for changing the appearance or style of particles that interact with a defined region. The primary controls mirror those found in the Style tab of the pEmitter node. Particles that intersect or enter the defined region change based on the parameters of this node.

Except for the pCustom node, this is the only node that modifies the particles' appearance rather than its motion. It is often used to trigger a change in the appearance in response to some event, such as striking a barrier.

Inputs
The pChange Style node has a single orange input by default. Like most particle nodes, this orange input accepts only other particle nodes. A green or magenta bitmap or mesh input appears on the node when you set the Region menu in the Region tab to either Bitmap or Mesh.

- **Input**: The orange input takes the output of other particle nodes.
- **Region**: The green or magenta region input takes a 2D image or a 3D mesh depending on whether you set the Region menu to Bitmap or Mesh. The color of the input is determined by whichever is selected first in the menu. The 3D mesh or a selectable channel from the bitmap defines the area where the custom particle node takes effect.

Basic Node Setup
Opposite of what you may think, to create a change in style that appears to be caused by some physical event, the pChange Style node should be placed before the node that creates the event. For example, below, the particles generated by the Emitter node change style after bouncing off a pBounce. Both the pChange Style and pBounce use the same Shape 3D node as the region. The pChange Style must be placed before the pBounce. If the pChange Style node is placed after the pBounce, the particles bounce off the region before the pChange Style calculates its effect. The particle will never get to intersect with the pChange Style node's region, and so the style never changes.
A pChange Style node placed before the pBounce node

Inspector

Randomize
The Random Seed slider and Randomize button are presented whenever a Fusion node relies on a random result. Two nodes with the same seed values will produce the same random results. Click the Randomize button to randomly select a new seed value, or adjust the slider to manually select a new seed value.

Change Sets
This option allows the user to change the particle’s Set to become influenced by forces other than the original particle. See “The Common Controls” in this chapter to learn more about Sets.
Style
This option allows the user to change the particle’s Style and thus the look. See “The Common Controls” in this chapter to learn more about Styles.

Common Controls

Conditions, Style, Region, and Settings Tabs
The Conditions, Style, Region, and Settings tabs are common to all Particle nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.

pCustom [pCu]

The pCustom node

pCustom Node Introduction
The pCustom node is used to create custom expressions that affect the properties of particles. This node is similar to the Custom node, except the calculations affect particles rather than pixels.

Inputs
The pCustom node has three inputs. Like most particle nodes, this orange input accepts only other particle nodes. The green and magenta inputs are 2D image inputs for custom image calculations. Optionally, there are teal or white bitmap or mesh inputs, which appear on the node when you set the Region menu in the Region tab to either Bitmap or Mesh.

– **Input:** The orange input takes the output of other particle nodes.
– **Image 1 and 2:** The green and magenta image inputs accept 2D images that are used for per pixel calculations and compositing functions.
– **Region:** The teal or white region input takes a 2D image or a 3D mesh depending on whether you set the Region menu to Bitmap or Mesh. The color of the input is determined by whichever is selected first in the menu. The 3D mesh or a selectable channel from the bitmap defines the area where the custom particle node takes effect.

Basic Node Setup
The pCustom node is placed in between the pEmitter and pRender. A Shape 3D node is used to create the region where the Custom particle event occurs.

A pCustom node using a Shape 3D node as the region where the custom event occurs
**Inspector**

All the same operators, functions, and conditional statements described for the Custom node apply to the pCustom node as well, including Pixel-read functions for the two image inputs (e.g., getr1w(x,y), getz2b(x,y), and so on).

![](image1)

The pCustom controls

**Number 1-8**

Numbers are variables with a dial control that can be animated or connected to modifiers exactly as any other control might. The numbers can be used in equations on particles at current time: n1, n2, n3, n4, ... or at any time: n1_at(float t), n2_at(float t), n3_at(float t), n4_at(float t), where t is the time you want. The values of these controls are available to expressions in the Setup and Intermediate tabs.

![](image2)

pCustom Position tab

**Position 1-8**

These eight point controls include 3D X,Y,Z position controls. They are normal positional controls and can be animated or connected to modifiers as any other node might. They are available to expressions entered in the Setup, Intermediate, and Channels tabs.
Setup 1-8

Up to eight separate expressions can be calculated in the Setup tab of the pCustom node. The Setup expressions are evaluated once per frame, before any other calculations are performed. The results are then made available to the other expressions in the node as variables s1, s2, s3, and s4.

Think of them as global setup scripts that can be referenced by the intermediate and channel scripts.
An additional eight expressions can be calculated in the Intermediate tab. The Intermediate expressions are evaluated once per frame, after the Setup expressions are evaluated. Results are available as variables i1, i2, i3, i4, i5, i6, i7, i8, which can be referenced by channel scripts.

Particle

Particle position, velocity, rotation, and other controls are available in the Particle tab. The following particle properties are exposed to the pCustom control:

<table>
<thead>
<tr>
<th>The following particle properties are exposed to the pCustom control:</th>
</tr>
</thead>
<tbody>
<tr>
<td>px, py, pz</td>
</tr>
<tr>
<td>vx, vy, vz</td>
</tr>
<tr>
<td>rx, ry, rz</td>
</tr>
<tr>
<td>sx, sy, sz</td>
</tr>
<tr>
<td>pxi1, pyi1</td>
</tr>
<tr>
<td>pxi2, pyi2</td>
</tr>
<tr>
<td>mass</td>
</tr>
<tr>
<td>size</td>
</tr>
<tr>
<td>id</td>
</tr>
<tr>
<td>r, g, b, a</td>
</tr>
<tr>
<td>rgnhit</td>
</tr>
<tr>
<td>rgndist</td>
</tr>
<tr>
<td>condscale</td>
</tr>
<tr>
<td>rgnix, rgniy, rgniz</td>
</tr>
<tr>
<td>rgnmx, rgnmy, rgnnz</td>
</tr>
<tr>
<td>w1, h1</td>
</tr>
<tr>
<td>w2, h2</td>
</tr>
<tr>
<td>i1, i2, i3, i4</td>
</tr>
<tr>
<td>s1, s2, s3, s4</td>
</tr>
<tr>
<td>n1..n8</td>
</tr>
<tr>
<td>p1x, p1y, p1z .. p4x, p4y, p4z</td>
</tr>
<tr>
<td>time</td>
</tr>
<tr>
<td>age</td>
</tr>
<tr>
<td>lifespan</td>
</tr>
</tbody>
</table>

Common Controls

Conditions, Style, Region, and Settings Tabs

The Conditions, Style, Region, and Settings tabs are common to all Particle nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.
The pCustom Force node

pCustom Force Node Introduction

The pCustom Force node allows you to change the forces applied to a particle system or subset. This node is one of the most complex and the most powerful node in Fusion. If you are experienced with scripting or C++ programming, you should find the structure and terminology used by the Custom Force node to be familiar.

The forces on a particle within a system can have their positions and rotations affected by forces. The position in XYZ and the Torque, which is the spin of the particle, are controlled by independent custom equations. The Custom Force node is used to create custom expressions and filters to modify the behavior. In addition to providing three image inputs, this node will allow for the connection of up to eight numeric inputs and as many as four XY position values from other controls and parameters in the node tree.

Inputs

The pCustom Force node has three inputs. Like most particle nodes, this orange input accepts only other particle nodes. A green and magenta are 2D image inputs for custom image calculations. Optionally there are teal or white bitmap or mesh inputs, which appear on the node when you set the Region menu in the Region tab to either Bitmap or Mesh.

- **Input:** The orange input takes the output of other particle nodes.
- **Image 1 and 2:** The green and magenta image inputs accept 2D images that are used for per-pixel calculations and compositing functions.
- **Region:** The teal or white region input takes a 2D image or a 3D mesh depending on whether you set the Region menu to Bitmap or Mesh. The color of the input is determined by whichever is selected first in the menu. The 3D mesh or a selectable channel from the bitmap defines the area where the pCustom Force takes effect.

Basic Node Setup

The pCustom Force node is inserted between a pEmitter and pRender node to serve as a catalyst for particles using advanced C++ and scripting.

A pCustom Force is applied to the particles generated by the pEmitter.
Inspector

The pCustom Force controls

The tabs and controls located in the Inspector are similar to the controls found in the pCustom node. Refer to the pCustom node in this chapter for more information.

Common Controls

**Conditions, Style, Region, and Settings Tabs**

The Conditions, Style, Region, and Settings tabs are common to all Particle nodes, so their descriptions can be found in "The Common Controls" section at the end of this chapter.

pDirectionalForce [pDF]

The pDirectional Force node

**pDirectional Force Node Introduction**

This node applies a unidirectional force that pulls the affected particles in a specified direction. Its primary controls affect the strength of the force, and the angle of the force's pull along the X, Y, and Z axis.

Since the most common use of this node is to simulate gravity, the default direction of the pull is down along the Y axis (-90 degrees), and the default behavior is to ignore regions and affect all particles.

**Inputs**

The pDirectional Force node has a single orange input by default. Like most particle nodes, this orange input accepts only other particle nodes. A green or magenta bitmap or mesh input appears on the node when you set the Region menu in the Region tab to either Bitmap or Mesh.

- **Input:** The orange input takes the output of other particle nodes.
- **Region:** The green or magenta region input takes a 2D image or a 3D mesh depending on whether you set the Region menu to Bitmap or Mesh. The color of the input is determined by whichever is selected first in the menu. The 3D mesh or a selectable channel from the bitmap defines the area where the directional force takes effect.
Basic Node Setup
The pDirectional Force node is placed in between the pEmitter and pRender and is often used to create gravity.

Inspector

Randomize
The Random Seed slider and Randomize button are presented whenever a Fusion node relies on a random result. Two nodes with the same seed values will produce the same random results. Click the Randomize button to select a new seed value randomly, or adjust the slider to select a new seed value manually.

Strength
Determines the power of the force. Positive values will move the particles in the direction set by the controls; negative values will move the particles in the opposite direction.

Direction
Determines the direction in X/Y space.

Direction Z
Determines the direction in Z space.
Common Controls

Conditions, Style, Region, and Settings Tabs
The Conditions, Style, Region, and Settings tabs are common to all Particle nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.

pEmitter [pEm]

pEmitter Node Introduction
The pEmitter node is the main source of particles (pImage Emitter is another) and will usually be the first node used in any new particle system. This node contains controls for setting the initial position, orientation, and motion of the particles, as well as controls for the visual style of each particle.

Like all other Particle nodes (with the exception of the pRender node), the pEmitter produces a particle set, not a visible image, and therefore cannot be displayed directly in a viewer. To view the output of a particle system, add a pRender node after the pEmitter.

Inputs
By default, the pEmitter node has no inputs at all. You can enable an image input by selecting Bitmap from the Style menu in the Style tab. Also, two region inputs, one for bitmap and one for mesh, appear on the node when you set the Region menu in the Region tab to either Bitmap or Mesh. The colors of these inputs change depending on the order in which they are enabled.

- **Style Bitmap Input**: This image input accepts a 2D image to use as the particles’ image. Since this image duplicates into potentially thousands of particles, it is best to keep these images small and square—for instance, 256 x 256 pixels.

- **Region**: The region inputs take a 2D image or a 3D mesh depending on whether you set the Region menu to Bitmap or Mesh. The color of the input is determined by whichever is selected first in the menu. The 3D mesh or a selectable channel from the bitmap defines the area where the particles are emitted.

Basic Node Setup
The pEmitter node starts the branch of a particle system that always ends with a pRender node. The pEmitter can feed directly into a pRender node to feed other particle nodes.

A pEmitter node connected to a pRender node is a typical setup for more particle systems.
The pEmitter inspector is divided into four main tabs and a common settings tab. The controls tab is the first tab displayed and it contains settings that affect the general setup of the particle cells emitted by the node. These settings do not directly affect the appearance of the cells or shape of the emitter region. They modify fundamental behaviors like quantity, duration, speed, and rotation of the particle cells.

### Randomize and Random Seed

The Random Seed slider is used to seed all the variance and random number generators used by the node when creating the particle system. Two pEmitter nodes with exactly the same settings for all controls and the same random seed will generate exactly the same particle system. Changing the random seed will cause variation between the nodes. Click the Randomize button to automatically set a randomly chosen value for the Random Seed.
**Number**

This control is used to set the amount of new particles generated on each frame. A value of 1 would cause one new particle to be generated each frame. By frame 10, there would be a total of 10 particles in existence (unless Particle Lifespan was set to fewer than 10 frames).

Animate this parameter to specify the number of particles generated in total. For example, if only 25 particles in total are desired, animate the control to produce five particles on frame 0--4, then set a key on frame five to generate zero particles for the remainder of the project.

**Number Variance**

This modifies the amount of particles generated for each frame, as specified by the Number control. For example, if Number is set to 10.0 and Number Variance is set to 2.0, the emitter will produce anywhere from 9-11 particles per frame. If the value of Number Variance is more than twice as large as the value of Number, it is possible that no particles will be generated for a given frame.

**Lifespan**

This control determines how long a particle will exist before it disappears or ‘dies.’ The default value of this control is 100 frames, although this can be set to any value. The timing of many other particle controls is relative to the Lifespan of the particle. For example, the size of a particle can be set to increase over the last 80% of its life, using the Size Over Life graph in the Style tab of the pEmitter.

**Lifespan Variance**

Like Number Variance, the Lifespan Variance control allows the Lifespan of particles produced to be modified. If Particle Lifespan was set to 100 frames and the Lifespan Variance to 20 frames, particles generated by the emitter would have a lifespan of 90–110 frames.

**Color**

This provides the ability to specify from where the color of each particle is derived. The default setting is Use Style Color, which will provide the color from each particle according to the settings in the Style tab of the pEmitter node.

The alternate setting is Use Color From Region, which overrides the color settings from the Style tab and uses the color of the underlying bitmap region.

The Use Color From Region option only makes sense when the pEmitter region is set to use a bitmap produced by another node in the composition. Particles generated in a region other than a bitmap region will be rendered as white when the Use Color From Region option is selected.

**Position Variance**

This control determines whether or not particles can be ‘born’ outside the boundaries of the pEmitter region. By default, the value is set to zero, which will restrict the creation area for new particles to the exact boundaries of the defined region. Increasing this control’s value above 0.0 will allow the particle to be born slightly outside the boundaries of that region. The higher the value, the ‘softer’ the region’s edge will become.

**Temporal Distribution**

In general, an effect is processed per frame, based on the comp frame rate. However, processing some particles only at the exact frame boundaries can cause pulsing. To make the behavior subtly more realistic, the particles can be birthed in subframe increments.

The default, At The Same Time setting renders on frame boundaries, where as the other two settings take advantage of sub frame rendering. Randomly Distributed randomizes birth times +/- around the frame number, eg birth 10 particles at random sub times 24.1 24.85, 24.21, 24.37 etc. one particle at a time. Evenly Distributed births particles at regular sub times, eg 10 particles, birth 1 at at time at 24.0, 24.1, 24.2, 24.3, 24.4, 24.5 ... 24.8, 24.9.
These settings are influenced by the Sub Frame Accuracy setting in the pRender node. The Sub Frame Accuracy slider controls how many in-between frames are calculated between each frame. The higher the value the more accurate the particle calculation but the longer the render times.

**Velocity**
The controls in the Velocity section determine the speed and direction of the particle cells as they are generated from the emitter region.

**Velocity and Velocity Variance**
These determine the initial speed or velocity of new particles. By default, the particle has no velocity and will not move from its point of origin unless acted upon by outside forces. A velocity setting of 10.0 would cause the particle to cross the entire width of the image in one step so a velocity of 1.0 would cause the particle to cross the width of the image over 10 frames.

Velocity Variance modifies the velocity of each particle at birth, in the same manner described in Lifespan Variance and Number Variance above.

**Inherit**
Inherit Velocity passes the emitter region’s velocity on to the particles. This slider has a wide range that includes negative and positive values. A negative value causes the particles to move in the opposite direction, a value of 1 will cause the particles to move with a velocity that matches the emitter region’s velocity, and a value of 2 causes the particles to move ahead of the emitter region.

**Inherit Velocity**
Inherit Velocity passes the emitter region’s velocity on to the particles. This slider has a wide range that includes negative and positive values. A negative value causes the particles to move in the opposite direction, a value of 1 will cause the particles to move with a velocity that matches the emitter region’s velocity, and a value of 2 causes the particles to move ahead of the emitter region.

**Angle and Angle Variance**
This determines the angle at which particles with velocity applied will be heading at their birth.

**Angle Z and Angle Z Variance**
This is as above, except this control determines the angle of the particles along the Z space axis (toward or away from the camera).

**Rotation**
Rotation controls are used to set the orientation of particle cells and animating that orientation over time.

**Rotation Mode**
This menu control provides two options to help determine the orientation of the particles emitted. When the particles are spherical, the effect of this control will be unnoticeable.

- **Absolute Rotation:** The particles will be oriented as specified by the Rotation controls, regardless of velocity and heading.
- **Rotation Relative To Motion:** The particles will be oriented in the same direction as the particle is moving. The Rotation controls can now be used to rotate the particle’s orientation away from its heading.

**Rotation XYZ and Rotation XYZ Variance**
These controls allow for Rotation of the individual particles. This can be particularly useful when dealing with a bitmap particle type, as the incoming bitmap may not be oriented in the desired direction.

Rotation XYZ Variance can be used to randomly vary the rotation by a specified amount around the center of the Rotation XYZ value to avoid having every particle oriented in the exact same direction.

**Spin**
Spin controls are auto animated controls that change the orientation of particle cells over time.
Spin XYZ and Spin Variance

These provide a spin to be applied to each particle at birth. The particles will rotate \( x \) degrees each frame, as determined by the value of Spin XYZ.

The Spin XYZ variances will vary the amount of rotation applied to each frame in the manner described by Number Variance and Lifespan Variance documented above.

Sets Tab

This tab contains settings that affect the physics of the particles emitted by the node. These settings do not directly affect the appearance of the particles. Instead, they modify behavior like velocity, spin, quantity, and lifespan.

Set 1-32

To assign the particles created by a pEmitter to a given set, simply select the checkbox of the set number you want to assign. A single pEmitter node can be assigned to one or multiple sets. Once they are assigned in the pEmitter, you can enable sets in other particle nodes so they only affect particles from specific pEmitters.

Style Tab

The Style tab provides controls that affect the appearance of the particles. For detailed information about the style Tab, see the "The Common Controls" section at the end of this chapter.
Region Tab

The Region tab controls the shape, size, and location of the area that emits the particle cells. This is often called the Emitter. Only one emitter region can be set for a single pEmitter node. If the pRenderer is set to 2D, then the emitter region will produce particles along a flat plane in Z Space. 3D emitter regions possess depth and can produce particles inside a user-defined, three-dimensional region. For more detail on the Region tab, see “The Common Controls” section at the end of this chapter.

Common Controls

*Conditions, Style, Region, and Settings Tabs*

The Conditions, Style, Region, and Settings tabs are common to all Particle nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.

**pFlock [pFl]**

The pFlock node

pFlock Node Introduction

The pFlock node can be used to simulate the behavior of organic systems, such as a flock of birds or a colony of ants. Its use can make an otherwise mindless particle system appear to be motivated, or acting under the direction of intelligence.

The pFlock node works through two basic principles. Each particle attempts to stay close to other particles and each particle attempts to maintain a minimum distance from other particles.

The strength of these “desires” produces the seemingly motivated behavior perceived by the viewer.

Inputs

The pFlock node has a single orange input by default. Like most particle nodes, this orange input accepts only other particle nodes. A green or magenta bitmap or mesh input appears on the node when you set the Region menu in the Region tab to either Bitmap or Mesh.

- **Input:** The orange background input takes the output of other particle nodes.
- **Region:** The green or magenta region input takes a 2D image or a 3D mesh depending on whether you set the Region menu to Bitmap or Mesh. The color of the input is determined by whichever is selected first in the menu. The 3D mesh or a selectable channel from the bitmap defines the area where the flocking takes effect.

Basic Node Setup

When combined with pFollow, the pFlock node can produce natural swarming behaviors that change direction.
A pFlock node applying more herd-type mentality to particles

**Inspector**

The pFlock controls

**Randomize**
The Random Seed slider and Randomize button are presented whenever a Fusion node relies on a random result. Two nodes with the same seed values will produce the same random results. Click the Randomize button to randomly select a new seed value, or adjust the slider to manually select a new seed value.

**Flock Number**
The value of this control represents the number of other particles that the affected particle will attempt to follow. The higher the value, the more visible “clumping” will appear in the particle system and the larger the groups of particles will appear.

**Follow Strength**
This value represents the strength of each particle’s desire to follow other particles. Higher values will cause the particle to appear to expend more energy and effort to follow other particles. Lower values increase the likelihood that a given particle will break away from the pack.
Attract Strength
This value represents the strength of attraction between particles. When a particle moves farther from other particles than the Maximum Space defined in the pFlock node, it will attempt to move closer to other particles. Higher values cause the particle to maintain its spacing energetically, resolving conflicts in spacing more rapidly.

Repel Strength
This value represents the force applied to particles that get closer together than the distance defined by the Minimum Space control of the pFlock node. Higher values will cause particles to move away from neighboring particles more rapidly, shooting away from the pack.

Minimum/Maximum Space
This range control represents the distance each particle attempts to maintain between it and other particles. Particles will attempt to get no closer or farther than the space defined by the Minimum/Maximum values of this range control. Smaller ranges will give the appearance of more organized motion. Larger ranges will be perceived as disorganized and chaotic.

Common Controls

Conditions, Style, Region, and Settings Tabs
The Conditions, Style, Region, and Settings tabs are common to all Particle nodes, so their descriptions can be found in "The Common Controls" section at the end of this chapter.

pFollow [pFo]
The pFollow node

pFollow Node Introduction
Inserting the pFollow node into a particle branch causes the particles to spring back and forth toward a follow object. The follow object can be positioned in 3D or animated to create a new motion path for the particles.

Inputs
The pFollow node has a single orange input by default. Like most particle nodes, this orange background input accepts only other particle nodes. A green bitmap or mesh input appears on the node when you set the Region menu in the Region tab to either Bitmap or Mesh.

- **Input:** The orange input takes the output of other particle nodes.
- **Region:** The green or magenta region input takes a 2D image or a 3D mesh depending on whether you set the Region menu to Bitmap or Mesh. The color of the input is determined by whichever is selected first in the menu. The 3D mesh or a selectable channel from the bitmap defines the area where particles will follow the position point.
Basic Node Setup

When combined with pFlock, the pFollow node can produce natural swarming behaviors that change direction.

A pFollow node introduces a follow object that influences the particles’ motion.

Inspector

Random Seed
The Random Seed slider and Randomize button are presented whenever a Fusion node relies on a random result. Two nodes with the same seed values will produce the same random results. Click the Randomize button to randomly select a new seed value, or adjust the slider to manually select a new seed value.

Position XYZ
The position controls are used to create the new path by positioning the follow object. Moving the XYZ parameters displays the onscreen position of the follow object. Animating these parameters creates the new path the particles will be influenced by.

Spring
The Spring setting causes the particles to move back and forth along the path. The spread of the spring motion increases over the life of the particles depending on the distance between the particles and the follow object. Higher spring settings increase the elasticity, while lower settings decrease elasticity.

Dampen
This value attenuates the spring action. A lower setting offers less resistance to the back and forth spring action. A higher setting applies more resistance.

Common Controls

Conditions, Style, Region, and Settings Tabs
The Conditions, Style, Region, and Settings tabs are common to all Particle nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.
pFriction [pFr]

The pFriction node

pFriction Node Introduction

The pFriction node applies resistance to the motion of a particle, slowing the particle’s motion through a defined region. This node produces two types of Friction. One type reduces the velocity of any particle intersecting/crossing the defined region, and one reduces or eliminates spin and rotation.

Inputs

The pFriction node has a single orange input by default. Like most particle nodes, this orange input accepts only other particle nodes. A green or magenta bitmap or mesh input appears on the node when you set the Region menu in the Region tab to either Bitmap or Mesh.

– **Input**: The orange input takes the output of other particle nodes.

– **Region**: The green or magenta region input takes a 2D image or a 3D mesh depending on whether you set the Region menu to Bitmap or Mesh. The color of the input is determined by whichever is selected first in the menu. The 3D mesh or a selectable channel from the bitmap defines the area where the friction occurs.

Basic Node Setup

The pFriction node is placed in between the pEmitter and pRender. A Shape 3D node is used to create the region the particles bounce off.

A pFriction node using a Shape 3D node as the region where friction is introduced to the particles.

Inspector

The pFriction controls
Random Seed
The Random Seed slider and Randomize button are presented whenever a Fusion node relies on a random result. Two nodes with the same seed values will produce the same random results. Click the Randomize button to randomly select a new seed value, or adjust the slider to manually select a new seed value.

Velocity Friction
This value represents the Friction force applied to the particle’s Velocity. The larger the value, the greater the friction, thus slowing down the particle.

Spin Friction
This value represents the Friction force applied to the particle’s Rotation or Spin. The larger the value, the greater the friction, thus slowing down the rotation of the particle.

Common Controls

Conditions, Style, Region, and Settings Tabs
The Conditions, Style, Region, and Settings tabs are common to all Particle nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.

pGradientForce [pGF]

The pGradient Force node

pGradient Force Node Introduction
The particles are affected by a force generated by the gradients in the alpha values of the input image. Particles will accelerate along the gradient, moving from white to black (high values to low values). This node can be used to give particles the appearance of moving downhill or following the contour of a provided shape.

Inputs
The pGradient Force node accepts two inputs: the default orange input from a particle node and one from a bitmap image with an alpha channel gradient. A magenta or teal bitmap or mesh input appears on the node when you set the Region menu in the Region tab to either Bitmap or Mesh.

- **Input**: The orange input takes the output of other particle nodes.
- **Input**: The green input takes the 2D image that contains the alpha channel gradient.
- **Region**: The magenta or teal region input takes a 2D image or a 3D mesh depending on whether you set the Region menu to Bitmap or Mesh. The color of the input is determined by whichever is selected first in the menu. The 3D mesh or a selectable channel from the bitmap defines the area where the gradient force occurs.
Basic Node Setup

The pGradient Force node is placed in between the pEmitter and pRender nodes. A Fast Noise node is used to create the alpha gradient used to modify the velocity of the particles.

A pGradient Force node using a Fast Noise node as the gradient to modify the particles' motion

Inspector

The pGradient Force controls

Randomize

The Random Seed slider and Randomize button are presented whenever a Fusion node relies on a random result.

Two nodes with the same seed values will produce the same random results. Click the Randomize button to randomly select a new seed value, or adjust the slider to manually select a new seed value.

Strength

Gradient Force has only one specific control, which affects the strength of the force and acceleration applied to the particles. Negative values on this control will cause the Gradient Force to be applied from black to white (low values to high values).

Common Controls

Conditions, Style, Region, and Settings Tabs

The Conditions, Style, Region, and Settings tabs are common to all Particle nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.
plImage Emitter [pLE]

The plImage Emitter node

plImage Emitter Node Introduction

The plImage Emitter node takes an input image and treats each pixel of the image as if it were a particle. The main differences between the plImage Emitter and the normal pEmitter is that instead of emitting particles randomly within a given region, this node emits pixels in a regular 2D grid with colors based on the input image.

Inputs

The plImage Emitter node has three inputs. Like most particle nodes, the orange input accepts only other particle nodes. Green and magenta inputs are 2D image inputs for custom image calculations. Optionally, there are teal or white bitmap or mesh inputs, which appear on the node when you set the Region menu in the Region tab to either Bitmap or Mesh.

- **Input:** Unlike most other particle nodes, the orange input on the plImage Emitter accepts a 2D image used as the emitter of the particles. If a region is defined for the emitter, this input is used to define the color of the particles.

- **Style Bitmap Input:** This image input accepts a 2D image to use as the particles’ image. Since this image duplicates into potentially thousands of particles, it is best to keep these images small and square—for instance, 256 x 256 pixels.

- **Region:** The teal or white region input takes a 2D image or a 3D mesh depending on whether you set the Region menu to Bitmap or Mesh. The color of the input is determined by whichever is selected first in the menu. The 3D mesh or a selectable channel from the bitmap defines the area where the particles are emitted.

Basic Node Setup

The plImage Emitter node is placed at the start of a particle branch, replacing the location of a pEmitter node. Below, a MediaIn node is used to emit particles using the colors from the clip.

A plImage Emitter node emits particles based on an image connected to the orange input.
The great majority of controls in this node are identical to those found in the pEmitter, and those controls are documented in that previous section. Below are the descriptions of the controls unique to the pImage Emitter node.

**X and Y Density**

The X and Y Density sliders are used to set the mapping of particles to pixels for each axis. They control the density of the sampling grid. A value of 1.0 for either slider indicates 1 sample per pixel. Smaller values will produce a looser, more pointillistic distribution of particles, while values above 1.0 will create multiple particles per pixel in the image.

**Alpha Threshold**

The Alpha Threshold is used for limiting particle generation so that pixels with semitransparent alpha values will not produce particles. This can be used to harden the edges of an otherwise soft alpha channel. The higher the threshold value, the more opaque a pixel must be before it will generate a particle. Note that the default threshold of 0.0 will create particles for every pixel, regardless of alpha, although many may be transparent and invisible.

**Lock Particle Color to Initial Frame**

Select this checkbox to force the particles to keep the color with which they were born throughout the life of the particle. If this is off, and the input image changes on successive frames, the particles will also change color to match the image. This allows video playback on a grid of particles.

**Create Particles Every Frame**

Enabling this creates a whole new set of particles every frame, instead of just one set on the frame. This can lead to very large particle systems but allows some interesting effects—for example, if the particles are given some initial velocity or if emitting from an animated source. Try a small velocity, an Angle Z of -90, and a seething Fast Noise as a source to get smoothly varying clouds of particles that you could fly through. Note that if this checkbox is left off, only one set of particles is ever created, and thus animating any of the emitter’s other controls will have no effect.
**X/Y/Z Pivot**
These controls allow you to position the grid of emitted particles.

**Use Z Channel for Particle Z**
If the input image used to generate the particles has a Z depth channel, that channel can be used to determine the initial position of the particle in Z space. This can have an interesting hollow shell effect when used in conjunction with camera rotation in the pRender node.

**Common Controls**

**Conditions, Style, Region, and Settings Tabs**
The Conditions, Style, Region, and Settings tabs are common to all Particle nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.

**Sets Tab**

![Image of pImage Emitter Sets tab]

**NOTE:** Pixels with a black (transparent) alpha channel will still generate invisible particles, unless you raise the Alpha Threshold above 0.0. This can slow down rendering significantly. An Alpha Threshold value of $1/255 = 0.004$ is good for eliminating all fully transparent pixels.

The pixels are emitted in a fixed-size 2D grid on the XY plane, centered on the Pivot position. Changing the Region from the default of All allows you to restrict particle creation to more limited areas. If you need to change the size of this grid, use a Transform 3D node after the pRender.

Remember that the various emitter controls apply only to particles when they are emitted. That is, they set the initial state of the particle and do not affect it for the rest of its lifespan. Since pImageEmitter (by default) emits particles only on the first frame, animating these controls will have no effect. However, if the Create Particles Every Frame checkbox is turned on, new particles will be emitted each frame and will use the specified initial settings for that frame.
The pKill node is used to destroy (kill) any particle that crosses or intersects its region. It has no specific controls, as it has only one possible affect on a particle. The controls found in the Region tab are normally used to limit this node by restricting the effect to particles that fall within a certain region, age, set, or by reducing the probability of the node applying to a given particle.

**Inputs**

The pKill node has a single orange input by default. Like most particle nodes, this orange input accepts only other particle nodes. A green bitmap or mesh input appears on the node when you set the Region menu in the Region tab to either Bitmap or Mesh.

- **Input:** The orange input takes the output of other particle nodes.
- **Region:** The green or magenta region input takes a 2D image or a 3D mesh depending on whether you set the Region menu to Bitmap or Mesh. The color of the input is determined by whichever is selected first in the menu. The 3D mesh or a selectable channel from the bitmap defines the area particles are killed.

**Basic Node Setup**

The pKill node is placed in between the pEmitter and pRender nodes. A Shape 3D node is used to create the region where the particles die.

**Inspector**

This node only contains common controls in the Conditions and Regions tabs. The Conditions and Regions controls are used to define the location, age, and set of particles that are killed.
Common Controls

Conditions, Style, Region, and Settings Tabs
The Conditions, Style, Region, and Settings tabs are common to all Particle nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.

pMerge [pMg]

The pMerge node

pMerge Node Introduction
This node has no controls whatsoever. It serves to combine particles from two streams. Any nodes downstream of the pMerge node will treat the two streams as one.

The combined particles will preserve any sets assigned to them when they were created, making it possible for nodes downstream of the pMerge to isolate specific particles when necessary.

Inputs
The pMerge node has two identical inputs, one orange and one green. These two inputs accept only other particle nodes.

- **Particle 1 and 2 Input:** The two inputs accept two streams of particles and merge them.

Basic Node Setup
The pMerge node connects two pEmitter nodes. The output of the pMerge can go on to feed other particle nodes or to a pRender.

A pMerge node combining two pEmitter nodes.
The pPoint Force node

**pPoint Force Node Introduction**

This node applies a force to the particles that emanate from a single point in 3D space. The pPoint Force can either attract or repel particles within its sphere of influence. There are four controls specific to the pPoint Force node.

**Inputs**

The pPoint Force node has a single orange input by default. Like most particle nodes, this orange input accepts only other particle nodes. A green bitmap or mesh input appears on the node when you set the Region menu in the Region tab to either Bitmap or Mesh.

- **Input:** The orange input takes the output of other particle nodes.
- **Region:** The green or magenta region input takes a 2D image or a 3D mesh depending on whether you set the Region menu to Bitmap or Mesh. The color of the input is determined by whichever is selected first in the menu. The 3D mesh or a selectable channel from the bitmap defines the area where the point force affects the particles.

**Basic Node Setup**

The pPoint Force node is inserted between a pEmitter and a pRender node.

The pPoint Force node positions a tangent force that particles are attracted to or repelled from.

**Inspector**

The pPoint Force controls
Randomize
The Random Seed slider and Randomize button are presented whenever a Fusion node relies on a random result. Two nodes with the same seed values will produce the same random results. Click the Randomize button to randomly select a new seed value, or adjust the slider to manually select a new seed value.

Strength
This parameter sets the Strength of the force emitted by the node. Positive values represent attractive forces; negative values represent repellent forces.

Power
This determines the degree to which the Strength of the force falls off over distance. A value of zero causes no falloff of strength. Higher values will impose an ever-sharper falloff in strength of the force with distance.

Limit Force
The Limit Force control is used to counterbalance potential problems with temporal sub-sampling. Because the position of a particle is sampled only once a frame (unless sub-sampling is increased in the pRender node), it is possible that a particle can overshoot the Point Force’s position and end up getting thrown off in the opposite direction. Increasing the value of this control reduces the likelihood that this will happen.

X, Y, Z Center Position
These controls are used to represent the X, Y, and Z coordinates of the point force in 3D space.

Common Controls

Conditions, Style, Region, and Settings Tabs
The Conditions, Style, Region, and Settings tabs are common to all Particle nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.

pRender [pRn]

The pRender node

pRender Node Introduction
The pRender node converts the particle system to either an image or geometry. The default is a 3D particle system, which must be connected to a Renderer 3D to produce an image. This allows the particles to be integrated with other elements in a 3D scene before they are rendered.

Inputs
The pRender node has one orange input, a green camera input, and a blue effects mask input. Like most particle nodes, this orange input accepts only other particle nodes. A green bitmap or mesh input appears on the node when you set the Region menu in the Region tab to either Bitmap or Mesh.
– **Input**: The orange input takes the output of other particle nodes.

– **Camera Input**: The optional green camera input accepts a camera node directly or a 3D scene with a camera connected that is used to frame the particles during rendering.

– **Effect Mask**: The optional blue input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input for 2D particles crops the output of the particles so they are seen only within the mask.

### Basic Node Setup

The pRender node is always placed at the end of a particle branch. If the pRender is set to 2D, then the output connects to other 2D nodes like a Merge node. If the pRender is set to 3D, the output connects to a 3D node like a Merge 3D.

![pRender node setup](image)

All particle branches end with a pRender node.

### Inspector

![pRender inspector](image)

The pRender controls

### Output Mode (2D/3D)

While the pRender defaults to 3D output, it can be made to render a 2D image instead. This is done with the 3D and 2D buttons on the Output Mode control. If the pRender is not connected to a 3D-only or 2D-only node, you can also switch it by selecting View > 2D Viewer from the viewer’s pop-up menu.
In 3D mode, the only controls in the pRender node that have any effect at all are Restart, Pre-Roll and Automatic Pre-Roll, Sub-Frame Calculation Accuracy, and Pre-Generate frames. The remaining controls affect 2D particle renders only. The pRender node also has a Camera input on the node tree that allows the connection of a Camera 3D node. This can be used in both 2D and 3D modes to allow control of the viewpoint used to render an output image.

**Render and the Viewers**

When the pRender node is selected in a node tree, all the onscreen controls from Particle nodes connected to it are presented in the viewers. This provides a fast, easy-to-modify overview of the forces applied to the particle system as a whole.

**Pre-Roll Options**

Particle nodes generally need to know the position of each particle on the last frame before they can calculate the effect of the forces applied to them on the current frame. This makes changing current time manually by anything but single frame intervals likely to produce an inaccurate image.

The controls here are used to help accommodate this by providing methods of calculating the intervening frames.

**Restart**

This control also works in 3D. Clicking on the Restart button will restart the particle system at the current frame, removing any particles created up to that point and starting the particle system from scratch at the current frame.

**Pre-Roll**

This control also works in 3D. Clicking on this button causes the particle system to recalculate, starting from the beginning of the render range up to the current frame. It does not render the image produced. It only calculates the position of each particle. This provides a relatively quick mechanism to ensure that the particles displayed in the views are correctly positioned.

If the pRender node is displayed when the Pre-Roll button is selected, the progress of the pre-roll is shown in the viewer, with each particle shown as point style only.

**Automatic Pre-Roll**

Selecting the Automatic Pre-Roll checkbox causes the particle system to automatically pre-roll the particles to the current frame whenever the current frame changes. This prevents the need to manually select the Pre-Roll button whenever advancing through time in jumps larger than a single frame. The progress of the particle system during an Automatic Pre-Roll is not displayed to the viewers to prevent distracting visual disruptions.

**About Pre-Roll**

Pre-Roll is necessary because the state of a particle system is entirely dependent on the last known position of the particles. If the current time were changed to a frame where the last frame particle state is unknown, the display of the particle is calculated on the last known position, producing inaccurate results.

To demonstrate:

1. Add a pEmitter and a pRender node to the composition.
2. View the pRender in one of the viewers.
3. Set the Velocity of the particles to 0.1.
4. Place the pEmitter on the left edge of the screen.
5. Set the Current Frame to 0.
6. Set a Render Range from 0–100 and press the Play button.
Observe how the particle system behaves.

Stop the playback and return the current time to frame 0.

In the pRender node, disable the Automatic Pre-Roll option.

Use the current time number field to jump to frame 10, and then to frames 60 and 90.

Notice how the particle system only adds to the particles it has already created and does not try to create the particles that would have been emitted in the intervening frames. Try selecting the Pre-Roll button in the pRender node. Now the particle system state is represented correctly.

For simple, fast-rendering particle systems, it is recommended to leave the Automatic Pre-Roll option on. For slower particle systems with long time ranges, it may be desirable to only Pre-Roll manually, as required.

Only Render in Hi-Q

Selecting this checkbox causes the style of the particles to be overridden when the Hi-Q checkbox is deselected, producing only fast rendering Point-style particles. This is useful when working with a large quantity of slow Image-based or Blob-style particles. To see the particles as they would appear in a final render, simply enable the Hi-Q checkbox.

View

This drop-down list provides options to determine the position of the camera view in a 3D particle system. The default option of Scene (Perspective) will render the particle system from the perspective of a virtual camera, the position of which can be modified using the controls in the Scene tab. The other options provide orthographic views of the front, top, and side of the particle system.

It is important to realize that the position of the onscreen controls for Particle nodes is unaffected by this control. In 2D mode, the onscreen controls are always drawn as if the viewer were showing the front orthographic view. (3D mode gets the position of controls right at all times.)

The View setting is ignored if a Camera 3D node is connected to the pRender node’s Camera input on the node tree, or if the pRender is in 3D mode.

Conditions

Blur, Glow, and Blur Blend

When generating 2D particles, these sliders apply a Gaussian blur, glows, and blur blending to the image as it is rendered, which can be used to soften the particles and blend them. The result is no different than adding a Blur after the pRender node in the node tree.

Sub-Frame Calculation Accuracy

This determines the number of sub-samples taken between frames when calculating the particle system. Higher values increase the accuracy of the calculation but also increase the amount of time to render the particle system.

Pre-Generate Frames

This control is used to cause the particle system to pre-generate a set number of frames before its first valid frame. This is used to give a particle system an initial state from which to start.

A good example of when this might be useful is in a shot where particles are used to create the smoke rising from a chimney. Set Pre-Generate Frames to a number high enough to ensure that the smoke is already present in the scene before the render begins, rather than having it just starting to emerge from the emitter for the first few frames.
Kill Particles That Leave the View
Selecting this checkbox control automatically destroys any particles that leave the visible boundaries of the image. This can help to speed render times. Particles destroyed in this fashion never return, regardless of any external forces acting upon them.

Generate Z Buffer
Selecting this checkbox causes the pRender node to produce a Z Buffer channel in the image. The depth of each particle is represented in the Z Buffer. This channel can then be used for additional depth operations like Depth Blur, Depth Fog, and Downstream Z Merging.

Enabling this option is likely to increase the render times for the particle system dramatically.

Depth Merge Particles
Enabling this option causes the particles to be merged using Depth Merge techniques, rather than layer-based techniques.

Scene Tab

The pRender Scene tab

Z Clip
The Z Clip control is used to set a clipping plane in front of the camera. Particles that cross this plane are clipped, preventing them from impacting on the virtual lens of the camera and dominating the scene.

Grid Tab
These controls do not apply to 3D particles.
The grid is a helpful, non-rendering display guide used to orient the 2D particles in 3D space. The grid is never seen in renders, just like a center crosshair is never seen in a render. The width, depth, number of lines, and grid color can be set using the controls found in this tab. These controls cannot be animated.

The pRender Grid tab

**Image Tab**

The controls in this tab are used to set the resolution, color depth, and pixel aspect of the rendered image produced by the node.

The pRender Image tab
**Process Mode**
Use this menu control to select the Fields Processing mode used by Fusion to render changes to the image. The default option is determined by the Has Fields checkbox control in the Frame Format preferences.

**Use Frame Format Settings**
When this checkbox is selected, the width, height, and pixel aspect of the rendered images by the node will be locked to values defined in the composition’s Frame Format preferences. If the Frame Format preferences change, the resolution of the image produced by the node will change to match. Disabling this option can be useful to build a composition at a different resolution than the eventual target resolution for the final render.

**Width/Height**
This pair of controls is used to set the Width and Height dimensions of the image to be rendered by the node.

**Pixel Aspect**
This control is used to specify the Pixel Aspect ratio of the rendered particles. An aspect ratio of 1:1 would generate a square pixel with the same dimensions on either side (like a computer display monitor), and an aspect of 0.9:1 would create a slightly rectangular pixel (like an NTSC monitor).

**Depth**
The Depth menu is used to set the pixel color depth of the particles. 32-bit pixels require 4X the memory of 8-bit pixels but have far greater color accuracy. Float pixels allow high dynamic range values outside the normal 0…1 range, for representing colors that are brighter than white or darker than black.

**Source Color Space**
You can use the Source Color Space menu to set the Color Space of the footage to help achieve a linear workflow. Unlike the Gamut tool, this doesn’t perform any actual color space conversion, but rather adds the source space data into the metadata, if that metadata doesn’t exist. The metadata can then be used downstream by a Gamut tool with the From Image option, or in a Saver, if explicit output spaces are defined there. There are two options to choose from:

- **Auto**: Automatically reads and passes on the metadata that may be in the image.
- **Space**: Displays a Color Space Type menu where you can choose the correct color space of the image.

**Source Gamma Space**
Using the Curve type menu, you can set the Gamma Space of the footage and choose to remove it by way of the Remove Curve checkbox when working in a linear workflow. There are three choices in the Curve type menu:

- **Auto**: Automatically reads and passes on the metadata that may be in the image.
- **Space**: Displays a Gamma Space Type menu where you can choose the correct gamma curve of the image.
- **Log**: Brings up the Log/Lin settings, similar to the Cineon tool. For more information, see Chapter 38, “Film Nodes” in the Fusion Reference Manual or Chapter 99 in the DaVinci Resolve Reference Manual.
Remove Curve
Depending on the selected Gamma Space or on the Gamma Space found in Auto mode, the Gamma Curve is removed from, or a log-lin conversion is performed on, the material, effectively converting it to a linear output space.

Motion Blur
As with other 2D nodes in Fusion, Motion Blur is enabled from within the Settings tab. You may set Quality, Shutter Angle, Sample Center, and Bias, and Blur will be applied to all moving particles.

**NOTE:** Motion Blur on 3D mode particles (rendered with a Renderer 3D) also requires that identical motion blur settings are applied to the Renderer 3D node.

pSpawn [pSp]

pSpawn Node Introduction
The pSpawn node makes each affected particle act as an emitter that can produce one or more particles of its own. The original particle continues until the end of its lifespan, and each of the particles it emits becomes wholly independent with a lifespan and properties of its own.

As long as a particle falls under the effect of the pSpawn node, it will continue to generate particles. It is important to restrict the effect of the node with limiters like Start and End Age, Probability, Sets and Regions, and by animating the parameters of the emitter so that the node is operative only when required.

Inputs
By default, the pSpawn node has a single orange input. Like most particle nodes, this orange input accepts only other particle nodes. You can enable an image input by selecting Bitmap from the Style menu in the Style tab. Also, two region inputs, one for bitmap and one for mesh, appear on the node when you set the Region menu in the Region tab to either Bitmap or Mesh. The colors of these inputs change depending on the order they are enabled.

- **Input:** The orange input accepts the output of other particle nodes.
- **Style Bitmap Input:** This image input accepts a 2D image to use as the particles’ image. Since this image duplicates into potentially thousands of particles, it is best to keep these images small and square—for instance, 256 x 256 pixels.
- **Region:** The region inputs take a 2D image or a 3D mesh depending on whether you set the Region menu to Bitmap or Mesh. The color of the input is determined by whichever is selected first in the menu. The 3D mesh or a selectable channel from the bitmap defines the area where the particles are emitted.
Basic Node Setup

The pSpawn node is placed between the pEmitter and pRender nodes. Using the Age parameter in the pSpawn’s Conditions tab, you can spawn new particles as the old ones die off. This is one way to have a trail of particles shoot up in the air like a rocket and burst into sparkling fireworks.

![Diagram of particle node setup](image)

A pSpawn node used to generate new particles at specific points in the old particles’ life

Inspector

The pSpawn node has a large number of controls, most of which exactly duplicate those found within the pEmitter node. There are a few controls that are unique to the pSpawn node, and their effects are described below.

![pSpawn node in the Inspector](image)

The pSpawn controls

Affect Spawned Particles

Selecting this checkbox causes particles created by spawning to also become affected by the pSpawn node on subsequent frames. This can exponentially increase the number of particles in the system, driving render times up to an unreasonable degree. Use this checkbox cautiously.

Velocity Transfer

This control determines how much velocity of the source particle is transferred to the particles it spawns. The default value of 1.0 causes each new particle to adopt 100 percent of the velocity and direction from its source particle. Lower values will transfer less of the original motion to the new particle.

Common Controls

Conditions, Style, Region, and Settings Tabs

The Conditions, Style, Region, and Settings tabs are common to all Particle nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.
pTangent Force Node Introduction

This node is used to apply a tangential force to the particles—a force that is applied perpendicularly to the vector between the pTangent Force’s region and the particle it is affecting.

Inputs

The pTangent Force node has a single orange input by default. Like most particle nodes, this orange input accepts only other particle nodes. A green bitmap or mesh input appears on the node when you set the Region menu in the Region tab to either Bitmap or Mesh.

- **Input:** The orange input takes the output of other particle nodes.
- **Region:** The green or magenta region input takes a 2D image or a 3D mesh depending on whether you set the Region menu to Bitmap or Mesh. The color of the input is determined by whichever is selected first in the menu. The 3D mesh or a selectable channel from the bitmap defines the area where the tangent force effects the particles.

Basic Node Setup

The pTangent Force node is inserted between a pEmitter and a pRender node.

Inspector

The pTangent Force controls...
The controls for this node are used to position the offset in 3D space and to determine the strength of the tangential force along each axis independently.

**Randomize**
The Random Seed slider and Randomize button are presented whenever a Fusion node relies on a random result.

Two nodes with the same seed values will produce the same random results. Click the Randomize button to randomly select a new seed value, or adjust the slider to manually select a new seed value.

**X, Y, Z Center Position**
These controls are used to represent the X, Y, and Z coordinates of the Tangent force in 3D space.

**X, Y, Z Center Strength**
These controls are used to determine the Strength of the Tangent force in 3D space.

**Common Controls**

**Conditions, Style, Region, and Settings Tabs**
The Conditions, Style, Region, and Settings tabs are common to all Particle nodes, so their descriptions can be found in "The Common Controls" section at the end of this chapter.

### pTurbulence \[pTr\]

The pTurbulence node imposes a frequency-based chaos on the position of each particle, causing the motion to become unpredictable and uneven. The controls for this node affect the strength and density of the Turbulence along each axis.

**Inputs**
The pTurbulence node has a single orange input by default. Like most particle nodes, this orange input accepts only other particle nodes. A green bitmap or mesh input appears on the node when you set the Region menu in the Region tab to either Bitmap or Mesh.

- **Input:** The orange input takes the output of other particle nodes.
- **Region:** The green or magenta region input takes a 2D image or a 3D mesh depending on whether you set the Region menu to Bitmap or Mesh. The color of the input is determined by whichever is selected first in the menu. The 3D mesh or a selectable channel from the bitmap defines the area of turbulence.
Basic Node Setup

The pTurbulence node is inserted between a pEmitter and a pRender node.

![pEmitter1 -> pTurbulence1 -> pRender1](image)

The pTurbulence node disturbs the rigid flow of particles for a more natural motion.

Inspector

![pTurbulence controls](image)

**Randomize**

The Random Seed slider and Randomize button are presented whenever a Fusion node relies on a random result. Two nodes with the same seed values will produce the same random results. Click the Randomize button to randomly select a new seed value, or adjust the slider to manually select a new seed value.

**X, Y, and Z Strength**

The Strength control affects the amount of chaotic motion imparted to particles.

**Strength Over Life**

This mini Spline Editor control can be used to control the amount of turbulence applied to a particle according to its age. For example, a fire particle may originally have very little turbulence applied at the start of its life, and as it ages, the turbulence increases.

**Density**

Use this control to adjust the density in the turbulence field. Lower values causes more particle cells to be affected similarly, almost as if “waves” of the turbulence field run through the particles, affecting groups of cells at the same time. Higher values add finer variations to more individual particle cells causing more of a spread in the turbulence field.

Common Controls

**Conditions, Style, Region, and Settings Tabs**

The Conditions, Style, Region, and Settings tabs are common to all Particle nodes, so their descriptions can be found in “The Common Controls” section at the end of this chapter.
pVortex [pVt]

The pVortex node

pVortex Node Introduction

The pVortex node applies a rotational force to each particle, causing them to be drawn toward the source of the Vortex. In addition to the Common Particle Controls, the pVortex node also has the following controls.

Inputs

The pVortex node has a single orange input by default. Like most particle nodes, this orange input accepts only other particle nodes. A green bitmap or mesh input appears on the node when you set the Region menu in the Region tab to either Bitmap or Mesh.

- **Input**: The orange input takes the output of other particle nodes.
- **Region**: The green or magenta region input takes a 2D image or a 3D mesh depending on whether you set the Region menu to Bitmap or Mesh. The color of the input is determined by whichever is selected first in the menu. The 3D mesh or a selectable channel from the bitmap defines the area of the vortex.

Basic Node Setup

The pVortex node is placed in between the pEmitter and pRender nodes.

A pVortex node creates a spiraling motion for particles that fall within its pull.

Inspector

The pVortex controls
Randomize
The Random Seed slider and Randomize button are presented whenever a Fusion node relies on a random result. Two nodes with the same seed values will produce the same random results. Click the Randomize button to randomly select a new seed value, or adjust the slider to manually select a new seed value.

Strength
This control determines the Strength of the Vortex Force applied to each particle.

Power
This control determines the degree to which the Strength of the Vortex Force falls off with distance.

X, Y, and Z Offset
Use these sliders to set the amount by which the vortex Offsets the affected particles.

Size
This is used to set the Size of the Vortex Force.

Angle X and Y
These sliders control the amount of rotational force applied by the Vortex along the X and Y axes.

Common Controls

Conditions, Style, Region, and Settings Tabs
The Conditions, Region, and Settings tabs are common to all Particle nodes, so their descriptions can be found in the following “The Common Controls” section.

The Common Controls
Particle nodes share a number of identical controls in the inspector. This section describes the Style, Conditions, Region, and Settings tabs that are common among particle nodes.

Inspector

The pEmitter Style tab

Style Tab
The Style Tab is common to the pEmitter, pSpawn, pChangeStyle, and pImage Emitter. It controls the appearance of the particles using general controls like type, size, and color.
Style

The Style menu provides access to the various types of particles supported by the Particle Suite. Each style has its specific controls, as well as controls it will share with other styles.

- **Point**: This option produces particles precisely one pixel in size. Controls that are specific to Point Style are Apply Mode and Sub Pixel Rendered.

- **Apply Mode**: This menu applies only to 2D particles. 3D particle systems are not affected. It includes Apply modes for Add and Merge. Add combines overlapping particles by adding together the color values of each particle. Merge uses a simple over operation to combine overlapping particles.

- **Sub Pixel Rendered**: This checkbox determines whether the point particles are rendered with Sub Pixel precision, which provides smoother-looking motion but blurrier particles that take slightly longer to render.

- **Bitmap**: This style produces particle cells based on an image file or another node in the Node editor. When this option is selected an orange image input appears on the node in the node editor. There are several controls for affecting the appearance and animation. In addition to the controls in the Style section, a Merge section is displayed at the bottom of the inspector when Bitmap is selected as the Style. The Merge section includes controls for additive or subtractive merges when the particle cells overlap.

- **Animate Over Time**: This menu includes three options for determining how movie files play when they are used as particle cell bitmaps. The Over Time setting plays the movie file sequentially. For instance, when the comps is on frame 2, frame 2 of the movie file is displayed, when the comp is on frame 3, frame 3 of the movie files is displayed and so on. If a particle cell is not generated until frame 50, it begins with frame 50 of the movie file. This causes all particle cells to use the same image on any give frame of the comp. The Particle Age setting causes each particle cell to begin with the first frame of the movie file, regardless of when the particle cell is generated. The Particle Birth Time setting causes each particle to begin with the frame that coincides with the frame of the particle cell birth time. For instance, if the particle is generated on frame 25, then it uses frame 25 of the movie file for the entire comp. Unlike the other two options, the Particle Birth Time setting holds the same frame for the duration of the comp

- **Time Offset**: This dial is used to slip or offset the starting frame used from the movie file. For instance, setting it to 10 will cause the movie file to start at frame 10 instead of frame 1.

- **Time Scale**: This slider is a multiplier on the frame. Instead of using an offset, it changes the starting frame by multiplying the frame by the value selected with the slider. For instance, if a value of 2 is selected then when the playhead reaches frame 2, the movie files displays frame 4 (2x2=4) and when the playhead reaches frame 8, the movie file displays frame 16 (8x2=16).

- **Gain**: The gain slider is a multiplier of the pixel value. It is used to apply a correction to the overall Gain of the Bitmap. Let’s say you have a bitmap particle cell that contains a pixel value of R0.5 G0.5 B0.4 and you add a Gain of 1.2, you end up with a pixel value of R0.6 G0.6, B0.48 (i.e., 0.4 * 1.2 = 0.48) while leaving black pixels unaffected. Higher values produce a brighter image, whereas lower values reduce both the brightness and the transparency of the image.

- **Style Bitmap**: This control appears when the Bitmap style is selected, along with an orange Style Bitmap input on the node’s icon in the Node view. Connect a 2D node to this input to provide images to be used for the particles. You can do this on the Node view, or you may drag and drop the image source node onto the Style Bitmap control from the Node Editor or Timeline, or right-click on the control and select the desired source from the Connect To menu.
– **Blob**: This option produces large, soft spherical particles, with controls for Color, Size, Fade timing, Merge method, and Noise.

– **Noise**: This slider only applies to 2D Blob particles. The noise slider is used to introduce a computer generated Perlin noise pattern into the blob particles in order to give the blobs more texture. A setting of 0 introduces no noise to the Blob particles and a setting of 1 introduces the maximum amount of noise.

– **Brush**: This styles produces particle cells based on any image file located in the brushes directory. There are numerous controls for affecting the appearance and animation.

– **Gain**: The gain slider is a multiplier of the pixel value. It is used to apply a correction to the overall Gain of the image that is used as the Brush. Let’s say you have a brush particle cell that contains a pixel value of R0.5 G0.5 B0.4 and you add a Gain of 1.2, you end up with a pixel value of R0.6 G0.6, B0.48 (i.e., 0.4 * 1.2 = 0.48) while leaving black pixels unaffected. Higher values produce a brighter image, whereas lower values reduce both the brightness and the transparency of the image.

– **Brush**: This menu shows the names of any image files stored in the Brushes directory. The location of the Brushes directory is defined in the Preferences dialog, under Path Maps. The default is the Brushes subdirectory within Fusion’s install folder.

– **Use Aspect From**: The Use Aspect From menu includes three settings for the aspect ratio of the brush image. You can choose image format to use the brush image’s native aspect ration. Choose Frame Format to use the aspect ratio set in the Frame Format Setting in the Fusion Preferences, or choose Custom to enter your own Pixel X and Y dimensions.

– **Line**: This style produces straight line-type particles with optional “falloff.” The Size to Velocity control described below (under Size Controls) is often useful with this Line type. The Fade control adjusts the amount of falloff over the length of the line.

– **Point Cluster**: This style produces small clusters of single-pixel particles. Point Clusters are similar to the Point style; however, they are more efficient when a large quantity of particles is required. This style shares parameters with the Point style. Additional controls specific to Point Cluster style are Number of Points and Number Variance.

– **Sub Pixel Rendered**: This checkbox determines whether the point particles are rendered with Sub Pixel precision, which provides smoother-looking motion but blurrier particles that take slightly longer to render.

– **Number of Points and Variance**: The value of this control determines how many points are in each Point Cluster.

**Color Controls**

The Color Controls select the color and Alpha values of the particles generated by the emitter.

**Color Variance**

These range controls provide a means of expanding the colors produced by the pEmitter. Setting the Red variance range at -0.2 to +0.2 will produce colors that vary 20% on either side of the red channel, for a total variance of 40%. If the pEmitter is set to produce R0.5, G0.5, B0.5 (pure gray), the variance shown above will produce points with a color range between R0.3, G0.5, B0.5, and R0.7, G0.5, B0.5.

To visualize color space as values between 0-256 or as 0-65535, change the values used by Fusion using the Show Color As option provided in the General tab within the Preferences dialog.
Lock Color Variance

This checkbox locks the color variance of the particles. Unlocking this allows the color variance to be applied differently to each color channel, giving rise to a broader range of colors.

Particles Color Over Life controls

Color Over Life

This standard gradient control allows for the selection of a range of color values to which the particle will adhere over its lifetime.

The left point of the gradient represents the particle color at birth. The right point shows the color of the particle at the end of its lifespan.

Additional points can be added to the gradient control to cause the particle color to shift throughout its life.

This type of control can be useful for fire-type effects (for example, the flame may start blue, turn orange, and end a darker red). The gradient itself can be animated over time by right-clicking on the control and selecting Animate from the contextual menu. All points on the gradient will be controlled by a single Color Over Life spline, which controls the speed at which the gradient itself changes. You may also use the From Image modifier, which produces a gradient from the range of colors in an image along a line between two points.

Particles Size and Fade controls
Size Controls

The majority of the Size Controls are self-explanatory. The Size and Size Variance controls are used to determine the size and degree of size variation for each particle. It is worth noting that the Point style does not have size controls (each point is a single pixel in size, and there is no additional control).

When a Bitmap Particle style is used, a value of 1.0 indicates that each particle should be the same size as the input bitmap. A value of 2.0 will scale the particle up in size by 200%. For the best quality particles, always try to make the input bitmap as big, or bigger, than the largest particle produced by the system.

For the Point Cluster style, the size control adjusts the density of the cluster, or how close together each particle will get.

There are additional size controls that can be used to adjust further the size of particles based on velocity and depth.

Size to Velocity

This increases the size of each particle relative to the velocity or speed of the particle. The velocity of the particle is added to the size, scaled by the value of this control. 1.0 on this control, such as for a particle traveling at 0.1, will add another 0.1 to the size (velocity * size to velocity + size = new size). This is most useful for Line styles, but the control can be used to adjust the size of any style.

Size Z Scale

This control measures the degree to which the size of each particle changes according to its Z position. The effect is to exaggerate or reduce the impact of perspective. The default value is 1.0, which provides a relatively realistic perspective effect. Objects on the focal plane (Z = 0.0) will be actual-sized. Objects farther along Z will become smaller. Objects closer along Z will get larger.

A value of 2.0 will exaggerate the effect dramatically, whereas a value of 0.0 will cancel the effects of perspective entirely.

Size Over Life

This spline control determines the size of a particle throughout its lifespan. The vertical scale represents a percentage of the value defined by the Size control, from 0 to 200%. The horizontal scale represents a percentage of the particle’s lifespan (0 to 100%).

This graph supports all the features available to a standard spline editor. These features can be accessed by right-clicking on the graph. It is also possible to view and edit the graph spline in the larger Spline Editor.

Fade Controls

This simple range slider provides a mechanism for fading a particle at the start and end of its lifetime. Increasing the Fade In value will cause the particle to fade in at the start of its life. Decreasing the Fade Out value will cause the particle to fade out at the end of its life.

This control’s values represent a percentage of the particle’s overall life, therefore, setting the Fade In to 0.1 would cause the particle to fade in over the first 10% of its total lifespan. For example, a particle with a life of 100 frames would fade in from frame 0…10.
Merge Controls
This set of particle controls affects the way individual particles are merged together. The Subtractive/Additive slider works as documented in the standard Merge node. The Burn-in control will cause the particles to overexpose, or "blow out," when they are combined.

None of the Merge controls will have any effect on a 3D particle system.

Blur Controls
This set of particle controls can be used to apply a Blur to the individual particles. Blurring can be applied globally, by age, or by Z depth position.

None of the Blur controls will have any effect on a 3D particle system.

Blur (2D) and Blur Variance (2D)
These controls apply blur to each particle. Unlike the Blur in the pRender node, this is applied to each particle independently before the particles are merged together. The Blur Variance slider modifies the amount of blur applied to each particle.

Blur Over Life
This spline graph controls the amount of blur that is applied to the particle over its life. The vertical scale represents a percentage of the value defined by the Blur control. The horizontal scale represents a percentage of the particle's lifespan.

This graph supports all of the features available to a standard Spline Editor. These features can be accessed by right-clicking on the graph. It is also possible to view and edit the spline in the larger Spline editor.

Z Blur (DoF) (2D) and DoF Focus
This slider control applies blur to each particle based on its position along the Z axis.

The DoF Focus range control is used to determine what area of the image remains in focus. Lower values along Z are closer to the camera. Higher values are farther away. Particles within the range will remain in focus. Particles outside that range will have the blur defined by the Z Blur control applied to them.
Conditions

Conditions Tab
The Conditions tab limits the particles that are affected by the node’s behavior. You can limit the particle using probability or more specifically using sets.

Probability
The Probability slider determines the percentage of chance that the node affects any given particle.

The default value of 1.0 affects all particles. A setting of 0.6 would mean that each particle has a 60 percent chance of being affected by the control.

Probability is calculated for each particle on each frame. For example, a particle that is not affected by a force on one frame has the same chance of being affected on the next frame.

Start/End Age
This range control can be used to restrict the effect of the node to a specified percentage of the particle lifespan.

For example, to restrict the effect of a node to the last 20 percent of a particle’s life, set the Start value to 0.8, and the End value remains at 1.0. The node on frames 80 through 100 only affects a particle with a lifespan of 100 frames.

Set Mode Menu
The Set Mode menu drives how the particle node influences the active particle sets. There are three options from this menu:

– **Ignore Sets**: The particle node disregards the state of the Set checkboxes and applies to all nodes.
– **Affect Specified Sets**: The particle node applies its behavior to the active Set checkboxes only.
– **Ignore Specified Sets**: The particle node applies its behavior to the inactive Set checkboxes only.
Set #

The state of a Set # checkbox determines if the Particle node’s effect will be applied to the particles in the set. It allows you to limit the effects of some nodes to a subset of particles.

Sets are assigned by the nodes that create particles. These include the pEmitter, plmage Emitter, pChangeStyle, and the pSpawn nodes.

Region Tab

The Region tab is used to restrict the node’s effect to a geometric region or plane, and to determine the area where particles are created if it’s a pEmitter node or where the behavior of a node has influence.

pEmitter Regions tab set to mesh

The Region tab is common to almost all particle nodes. In the pEmitter node Emitter Regions are used to determine the area where particles are created. In most other tools it is used to restrict the tool’s effect to a geometric region or plane. There are seven types of regions, each with its own controls. Only one emitter region can be set for a single pEmitter node. If the pRender is set to 2D, then the emitter region will produce particles along a flat plane in Z Space. 3D emitter regions possess depth and can produce particles inside a user-defined, three-dimensional region.

Region Mode Menu

The Region Mode menu includes seven types of regions to define the area, each with its controls.

- **All:** In 2D, the particles will be created anywhere within the boundaries of the image. In 3D, this region describes a cube 1.0 x 1.0 x 1.0 units in size.
- **Bézier:** Bézier mode uses a user-created polyline to determine the region where particles are created. The Bézier mode works in both 2D and 3D modes; however, the Bézier polyline region can only be created in 2D.
  
  To animate the shape of the polyline over time or to connect it to another polyline, right-click the Shape animation label at the bottom of the inspector and select the appropriate option from the drop-down menu.

- **Bitmap:** A Bitmap source from one of the other nodes in the composition will be used as the region where particles are born.

- **Cube:** A full 3D Cube is used to determine the region within which particles are created. The height, width, depth, and XYZ positions can all be determined by the user and be animated over time.

- **Line:** A simple line control determines where particles are created. The line is composed of two end-points, which can be connected to Paths or Trackers, as necessary. This type of emitter region includes X, Y, and Z position controls for the start and end of the line.

- **Mesh:** Any 3D Mesh can be used as a region. In Mesh mode, the region can also be restricted by the Object ID using the Object ID slider. See below for a more in-depth explanation of how mesh regions work.
- **Rectangle**: The Rectangle region type is like the Cube type, except that this region has no depth in Z space. Unlike other 2D emitter regions, this region can be positioned and rotated in Z space.

- **Sphere**: This is a spherical 3D emitter region with Size and Center Z controls. Sphere (3D) is the default region type for a new pEmitter node.

**Mesh Regions**

**Region Type**
The Region Type drop-down menu allows you to choose whether the region will include the inner volume or just the surface. For example, with a pEmitter mesh region, this determines if the particles emit from the surface or the full volume.

**Winding Rule and Winding Ray Direction**
The Winding Rule and Winding Ray Direction parameters determine how the mesh region handles particle creation with meshes that are not closed, as is common in many meshes imported from external applications. This scenario is common with imported mesh geometry, and even geometry that appears closed will frequently appear to "leak" thanks to improperly welded vertices.

To determine if a particle is in the interior of an object, a ray is cast from infinity through that particle and then out to -infinity. The Winding Ray Direction determines which direction this ray is cast in. Each time a surface is pierced by the ray, it is recorded and added onto a total to generate a winding number. Going against a surfaces normal counts as +1, and going with the normal counts as -1.

The Winding Rule is then used to determine what is inside/outside. For example, setting the Winding Rule to Odd means that only particles with odd values for the winding number are kept when creating the particles. The exact same approach is used to ensure that polylines that intersect themselves are closed properly.

For example, the following node tree and image show two image planes being used as a mesh region for particle creation.

![Node Tree and Image](image-url)
By setting the region’s Winding Ray Direction to the Z (blue) axis, this mesh can then be treated as a closed volume for purposes of particle creation, as pictured below.

Limit By ObjectID
Selecting this checkbox allows the Object ID slider to select the ObjectID used as part of the region.

Style Tab
The Style tab exists in the pEmitter, pSpawn, pChangeStyle, and pImage Emitter. It controls the appearance of the particles, allowing the look of the particles to be designed and animated over time.

Style
The Style menu provides access to the various types of particles supported by the Particle Suite. Each style has its specific controls, as well as controls it will share with other styles.

- **Point Style**: This option produces particles precisely one pixel in size. Controls that are specific to Point style are Apply Mode and Sub Pixel Rendered.

  - **Add**: Overlapping particles are combined by adding together the color values of each particle.
  - **Merge**: Overlapping particles are merged.

- **Bitmap Style and Brush Style**: Both the Bitmap and Brush styles produce particles based on an image file. The Bitmap style relies on the image from another node in the node tree, and the Brush style uses image files in the Brushes directory. They both have numerous controls for affecting their appearance and animation, described below.

- **Blob Style**: This option produces large, soft spherical particles, with controls for Color, Size, Fade timing, Merge method, and Noise.

- **Line Style**: This style produces straight line-type particles with optional “falloff.” The Size to Velocity control described below (under Size Controls) is often useful with this Line type. The Fade control adjusts the amount of falloff over the length of the line.

- **Point Cluster Style**: This style produces small clusters of single-pixel particles. Point Clusters are similar to the Point style; however, they are more efficient when a large quantity of particles is required. This style shares parameters with the Point style. Additional controls specific to Point Cluster style are Number of Points and Number Variance.

Style Options
The following options appear only on some of the styles, as indicated below.

Apply Mode (Point and Point Cluster)
This control applies only to 2D particles; 3D particle systems are not affected.

- **Add**: Overlapping particles are combined by adding together the color values of each particle.
- **Merge**: Overlapping particles are merged.
Sub Pixel Rendered (Point and Point Cluster)
This checkbox determines whether the point particles are rendered with Sub Pixel precision, which provides smoother-looking motion but blurrier particles that take slightly longer to render.

Number of Points and Variance (Point Cluster)
The value of this control determines how many points are in each Point Cluster.

Animate (Bitmap Style)
If the Bitmap source is a movie file or image sequence, this menu determines which frame is grabbed from the source and applied to newly-created particles.

– **Over Time:** All particles use the image produced by the Style Bitmap node at the current time, and change to each successive image together in step, as time increases. A particle created at frame 1 will contain the image at frame 1 of the Style Bitmap. At frame 2, the original particle will use the image from frame 2, and so will any new particles. All created particles will share the same bitmap image from their source at all times.

– **Particle Age:** Each particle animates through the sequence of images provided by the Style Bitmap node, independently of other particles. In other words, an individual particle’s appearance is taken from the Style Bitmap node at successive times, indexed by its age.

– **Particle Birth Time:** New particles take the image from the Style Bitmap node at the current time and keep it unchanged until the end of the particle’s lifespan. Thus, particles generated on a given frame will all have the same appearance and will stay that way.

Time Offset (Bitmap Style)
This control allows the Bitmap source frame to be offset in time from the current frame.

Time Scale (Bitmap Style)
This control scales the time range of the source bitmap images by a specified amount. For example, a scale of 2 will cause the particle created at frame 1 to be read from the bitmap source at frame 2.

Gain (Bitmap and Brush Style)
This control applies a gain correction to the image used as the bitmap. Higher values produce a brighter image, whereas lower values reduce both the brightness and the transparency of the image.

Style Bitmap (Bitmap Style)
This control appears when the Bitmap style is selected, along with an orange Style Bitmap input on the node’s icon in the Node view. Connect a 2D node to this input to provide images to be used for the particles. You can do this on the Node view, or you may drag and drop the image source node onto the Style Bitmap control from the Node Editor or Timeline, or right-click on the control and select the desired source from the Connect To menu.

Brush (Brush Style)
This menu shows the names of any image files stored in the Brushes directory. The location of the Brushes directory is defined in the Preferences dialog, under Path Maps. The default is the Brushes subdirectory within Fusion’s install folder. If no images are in this directory, the only option in the menu will be None, and no particles will be rendered.

Noise (Blob Style)
Increasing this control’s value will introduce grain-type noise to the blobby particle.

Fade (Line Style)
The Fade control adjusts the falloff over the line particle’s length.
The default value of 1.0 causes the line to fade out completely by the end of the length.
Color Controls
The Color Controls select the color and Alpha values of the particles generated by the emitter.

Color Variance
These range controls provide a means of expanding the colors produced by the pEmitter. Setting the Red variance range at -0.2 to +0.2 will produce colors that vary 20% on either side of the red channel, for a total variance of 40%. If the pEmitter is set to produce R0.5, G0.5, B0.5 (pure gray), the variance shown above will produce points with a color range between R0.3, G0.5, B0.5, and R0.7, G0.5, B0.5.

To visualize color space as values between 0-256 or as 0-65535, change the values used by Fusion using the Show Color As option provided in the General tab within the Preferences dialog.

Lock Color Variance
This checkbox locks the color variance of the particles. Unlocking this allows the color variance to be applied differently to each color channel, giving rise to a broader range of colors.

Particles Color Over Life controls

Color Over Life
This standard gradient control allows for the selection of a range of color values to which the particle will adhere over its lifetime.

The left point of the gradient represents the particle color at birth. The right point shows the color of the particle at the end of its lifespan.

Additional points can be added to the gradient control to cause the particle color to shift throughout its life.

This type of control can be useful for fire-type effects (for example, the flame may start blue, turn orange and end a darker red). The gradient itself can be animated over time by right-clicking on the control and selecting Animate from the contextual menu. All points on the gradient will be controlled by a single Color Over Life spline, which controls the speed at which the gradient itself changes. You may also use the From Image modifier, which produces a gradient from the range of colors in an image along a line between two points.
Chapter 114

Position Nodes

This chapter details the Position nodes available in Fusion.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing Medialn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

Volume Fog [VLF] 2257
Volume Mask [VLM] 2264
Z to World Pos [Z2W] 2268
WPP Concept 2269
The Common Controls 2271
Volume Fog [VLF]

The Volume Fog node

Volume Fog Node Introduction

The Volume Fog node is used to create sophisticated volumetric fog on images containing XYZ Position channels.

As opposed to 3D-rendered volumetric fog, it works on 2D images and delivers much faster results and interactive feedback when setting up the fog. See the “WPP Concept” section at the end of this chapter for further explanation of how this technology works and to learn about the required imagery.

Basic Node Setup

The Volume Fog node takes an image input; in the example below, it is a Renderer 3D with World Position enabled in the output channels. Another input is the 3D scene, which contains the camera. A Fast Noise node generates the fog texture.

Volume Fog Node Structure

Inputs

The following inputs appear on the Volume Fog node in the Node Editor.

- **Image:** The orange input accepts the primary image where the fog will be applied. This image contains a World Position Pass in the XYZ Position channels.

- **Fog Image:** The green Fog image input is for creating volumetric fog with varying depth and extent; a 2D image can be connected here. A good starting point is to use a Fast Noise at a small resolution of 256 x 256 pixels.

- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the fog to certain areas.

- **Scene Input:** The magenta scene input accepts a 3D scene containing a 3D Camera.
Inspector

The Volume Fog Shape tab

Shape Tab
The Shape tab defines the size and location of the fog volume. You can either use the Pick buttons to select the location and orientation in the viewer or use the Translation, Rotation, and Scale controls.

Shape
This menu switches between a basic spherical or rectangular volume to be placed in your image. These volumes can then be further refined using the Fog image and effect mask.

Pick
Drag the Pick button into the viewer to select the XYZ coordinates from any 3D scene or 2D image containing XYZ values, such as a rendered World Pass, to position the center of the Volume object. When picking from a 2D image, make sure it’s rendered in 32-bit float to get full precision.

X, Y, Z Offset
These controls can be used to position the center of the fog volume manually or can be animated or connected to other controls in Fusion.

Rotation Pick
Drag the Pick button into the viewer to select the rotational values from any 3D Scene or 2D image containing those values, like an XYZ-Normal-Pass, to reorient the fog volume.
When picking from a 2D image, like an XYZ Normal pass, make sure it’s rendered in 32-bit float to get full precision and accurate rotational values.

X, Y, Z Rotation
Use these controls to rotate the fog volume around its center.

X, Y, Z Scale
Scale the fog volume in any direction from its center to refine further the overall Size value specified below.
**Size**
The overall size of the fog volume created.

**Soft Edge**
Controls how much the fog volume is faded toward the center from its perimeter to achieve a softer look.

![The Volume Fog Color tab](image)

**Color Tab**
The Color tab controls the detail and color of the fog.

**Adaptive Samples**
Volumes images consist of multiple layers, so there may be 64 layers in a volume. This checkbox adjusts the rendering algorithm for how to best blend those layers.

**Dither**: Applies a form of noise to improve the blending and hide visible layer differences.

**Samples**
Determines how many times a "ray" shot into the volume will be evaluated before the final image is created. Not unlike raytracing, higher values lead to more detail inside the volume but also increase render times.

**Z Slices**
The higher the Z Slices value, the more images from the connected Fog image sequence will be used to form the depth of the volume.

You can, for example, use a Fast Noise with a high Seethe Rate to create such a sequence of images. Be careful with the resolution of the images. Higher resolutions can require a large amount of memory. As a rule of thumb, a resolution of 256 x 256 pixels with 256 Z Slices (i.e., forming a 256 x 256 x 256 cubic volume, which will use up to 256 MB for full color 32-bit float data) should give you a good starting point.
**First Slice Time**
Determines which frame of the Global Range is used to deliver the first slice from the connected fog image sequence.

Make sure that both Global In and Global Out, as well as the valid range of your source node, fall within the range of First Slice Time + Z Slices.

**Color**
Allows you to modify the color of the fog generated. This will multiply over any color provided by the connected Fog image.

**Gain**
Increases or decreases the intensity of the fog. More Gain will lead to a stronger glow and less transparency in the fog. Lower values let the fog appear less dense.

**Subtractive/Additive Slider**
Similar to the Merge node, this value controls whether the fog is composed onto the image in Additive or Subtractive mode, leading to a brighter or dimmer appearance of the fog.

**Fog Only**
This option outputs the generated fog on a black background, which then can be composited manually or used as a mask on a Color Corrector for further refinement.

**Noise Tab**
The Noise tab controls the shape and pattern of the noise added to the fog.

**Detail**
Increase the value of this slider to produce a greater level of detail in the noise result. Larger values add more layers of increasingly detailed noise without affecting the overall pattern. High values take longer to render but can produce a more natural result.

**Gain**
This control increases or decreases the brightest parts of the noise map.

**Brightness**
This control adjusts the overall brightness of the noise map, before any gradient color mapping is applied. In Gradient mode, this produces a similar effect to the Offset control.
Translation
Use the Translation coordinate control to pan and move the noise pattern.

Noise Rotation
Use the Rotation controls to orient the noise pattern in 3D.

Seethe
Adjust this thumbwheel control to interpolate the noise map against a different noise map. This will cause a crawling shift in the noise, like it was drifting or flowing. This control must be animated to affect the noise over time.

Discontinuous
Normally, the Noise function interpolates between values to create a smooth, continuous gradient of results. Enable this checkbox to create hard discontinuity lines along some of the noise contours. The result will be a dramatically different effect.

Inverted
Select this checkbox to invert the noise, creating a negative image of the original pattern. This is most effective when Discontinuous is also enabled.

The Volume Fog Camera tab

Camera Tab
For a perfect evaluation of a fog volume, a camera or 3D scene can be connected to the Scene input of the node.

Camera
If multiple cameras are available in the connected Scene input, this menu allows the selection of the correct camera needed to evaluate the fog volume. Instead of connecting a camera, position values can be provided manually or by connecting the XYZ values to other controls.

Translation Pick
Drag the Pick button into the viewer to select XYZ coordinates from any 3D scene or 2D image containing XYZ values, like a rendered World Pass, to define the center of the camera. When picking from a 2D image, make sure it’s rendered in 32-bit float to get full precision.

X, Y, Z Offset
These controls can be used to define the center of the camera manually or can be animated or connected to other controls in Fusion.
The Volume Fog Light tab

**Light Tab**
To utilize the controls in the Light tab, you must have actual lights in your 3D scene. Connect that scene, including Camera and Lights, to the 3D input of the node.

**Do Lighting**
Enables or disables lighting calculations. Keep in mind that when not using OpenCL (i.e., rendering on the CPU), these calculations may become a bit slow.

**Do In-Scattering**
Enables or disables light-scattering calculations. The volume will still be lit according to the state of the Do Lighting checkbox, but scattering will not be performed.

**Light Samples**
Determines how accurate the lighting is calculated. Higher values mean more accurate calculation at the expense of longer render times.

**Density**
This is similar to scattering in that it makes the fog appear thicker. With a high amount of scattering, though, the light will be scattered out of the volume before it has had much chance to travel through the fog, meaning it won’t pick up a lot of the transmission color. With a high density instead, the fog still appears thicker, but the light gets a chance to be transmitted, thus picking up the transmission color before it gets scattered out. Scattering is affected by the light direction when Asymmetry is not 0.0. Density is not affected by light direction at all.
Scattering
Determines how much of the light bouncing around in the volume ends up scattering the light out of
the fog. If the light scatters more, or more accurately, then there’s a higher probability of the light being
scattered out of the volume, hence less light is left to continue through the fog. This option can make
the fog seem denser.

Asymmetry
Determines in what direction the light is scattered. A value of 0 produces uniform, or isotropic,
scattering, meaning all directions have equal probability. A value greater than 0 causes “forward
scattering,” meaning the light is scattered more into the direction of the light rays. This is similar to
what happens with water droplets in clouds. A value smaller than 0 produces “back scattering,” where
the light is more scattered back toward the original light source.

Transmission
Defines the color that is transmitted through the fog. The light that doesn’t get scattered out will tend
toward this color. It is a multiplier, though, so if you have a red light, but blue transmission, you won’t
see any blue.

Reflection
Changes the intensity of the light that is scattered out. Reflection can be used to modify the overall
color before Emission is added. This will be combined with the color channels of the volume texture
and then used to scale the values. The color options and the color channels of the volume texture are
multiplied together, so if the volume texture were red, setting the Reflection color options to blue
would not make the result blue. In such a case, they will multiply together to produce black.

Emission
This adds a bit of “glowing” to the fog, adding energy/light back into the calculation. If there are no
lights in the scene, and the fog emission is set to be 1.0, the results are similar to no lighting, like
turning off the Do Lighting option. Glowing can also be done while producing a different kind of look,
by having a Transmission greater than 1. This, however, would never happen in the real world.

Common Controls
Settings Tab
The Settings tab in the Inspector is also duplicated in other Position nodes. These common controls
are described in detail at the end of this chapter in “The Common Controls” section.

Examples
In these examples, we are looking at a volume from the outside. On the left, you see how the
Volume Fog looks with straight accumulation. That means the Do Lighting option is turned off.

On the right, you see the same volume with lighting/scattering turned on, and a single
point light.
Here, we have a slightly more complex Volume.

On the left with straight accumulation; in the middle with lighting, scattering, and a single point light; and on the right, the light in the scene has been moved, which also influences the look of the volume.

Volume Mask [VLM]

The Volume Mask node

Volume Mask Node Introduction

The Volume Mask node is used to create volumetric masks from images containing XYZ Position channels.

This can, for example, be used to isolate objects for color correction without the need to track or rotoscope the scene. See the “WPP Concept” section later in this chapter for further explanation on how this technology works and to learn about the required imagery.

Inputs

The following three inputs appear on the Volume Mask node in the Node Editor:

- **Image**: The orange image input accepts a 2D image containing a World Position Pass in the XYZ Position channels.
- **Mask Image**: An image can be connected to the green mask image input for refining the mask.
- **Effect Mask**: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the volume mask to certain areas.

Basic Node Setup

Below, a MediaIn labeled RGBA contains the main rendered image from a 3D scene. A World Position Pass from a 3D-rendered scene is labeled WPP_PASS. The Channel Booleans node is used to map the X position pass to the red channel, Y to the green channel, and Z to the blue channel. The Volume Mask tool extracts the 3D position information from the World Position Pass to place a mask in 3D.
space. The mask is then used as an effect mask on a color corrector to selectively color correct objects in a 3D scene.

![Image of a Volume Mask tool](image)

A Volume Mask tool takes advantage of World Position Pass for color correction in a 3D scene

**Inspector**

![Image of the Volume Mask Shape tab](image)

The Volume Mask Shape tab

**Shape Tab**

The Shape tab defines the size and location of the Volume Mask. You can either use the Pick buttons to select the location and orientation in the viewer or use the Translation, Rotation, and Scale controls.

**Shape**

This menu switches between a spherical or rectangular mask to be placed in your image. The mask can be further refined using the mask image input.

**Translation Pick**

Drag the Pick button into the viewer to select XYZ coordinates from any 3D scene or 2D image containing XYZ values, like a rendered World Pass, to position the center of the Volume Mask. When picking from a 2D image, make sure it's rendered in 32-bit float to get full precision.
**X, Y, Z Offset**
These controls can be used to position the center of the mask manually or can be animated or connected to other controls in Fusion.

**Rotation Pick**
Drag the Pick button into the viewer to select rotational values from any 3D scene or 2D image containing those values, like an XYZ Normal pass, to reorient the mask.

When picking from a 2D image, like an XYZ Normal pass, make sure it’s rendered in 32-bit float, and use World Space coordinates to get full precision and the correct rotational values.

**X, Y, Z Rotation**
Use these controls to rotate the mask around its center.

**X, Y, Z Scale**
Scale the mask in any direction from its center to further refine the overall Size value specified below.

**Size**
The overall size, in X, Y, and Z, of the mask created.

**Soft Edge**
Controls how much the Volume is faded toward the center from its perimeter to achieve a softer look.

---

![The Volume Mask Color tab](image)

**Color Tab**
The Color tab controls the color and blending of the mask image.

**Color**
Allows you to modify the color of the generated Volume Mask. This will add to any color provided by the connected mask image.

**Subtractive/Additive Slider**
Similar to the Merge node, this value controls whether the mask is composed onto the image in Additive or Subtractive mode, leading to a brighter or dimmer appearance of the mask.
**Mask Only**
Outputs the generated mask on a black background, which then can be used as a mask on a Color Corrector for further refinement.

**Camera Tab**
For a perfect evaluation of a Volume, a camera or 3D scene can be connected to the Scene input of the node.

**Camera**
If multiple cameras are available in the connected Scene input, this drop-down menu allows you to choose the correct camera needed to evaluate the Volume.

Instead of connecting a camera, position values can also be provided manually or by connecting the XYZ values to other controls.

**Translation Pick**
Drag the Pick button into the viewer to select XYZ coordinates from any 3D scene or 2D image containing XYZ values, like a rendered World Pass, to define the center of the camera.

When picking from a 2D image, make sure it’s rendered in 32-bit float to get full precision.

**X, Y, Z Offset**
These controls can be used to define the center of the camera manually or can be animated or connected to other controls in Fusion.

**Common Controls**

**Settings Tab**
The Settings tab in the Inspector is also duplicated in other Position nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.
Z to World Pos [Z2W]

Z to World Pos Node Introduction

The Z to World Pos node is used to either generate a World Position Pass from a Z channel and a 3D Camera or a Z channel from a World Position Pass and a 3D Camera.

Creating a World Position Pass from Z-depth can be useful when your 3D application is not capable of creating a WPP.

It can also be used when a 3D-tracking software outputs a per-pixel Z-depth together with the 3D Camera. Thus, the Volume Mask and Volume Fog could be applied to real-world scenes. The quality of the resulting WPP depends mainly on the quality of the incoming Z channel.

See the “WPP Concept” section for further explanation on how this technology works and to learn about the required imagery.

Inputs

The following inputs appear on the node tile in the Node Editor:

- **Image:** The orange image input accepts an image containing a World Position Pass or a Z-depth pass, depending on the desired operation.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the World Position Pass to certain areas.
- **Scene Input:** The magenta scene input accepts a 3D scene input containing a 3D Camera.

Basic Node Setup

Below, a MediaIn labeled RGBA contains the main rendered image from a 3D scene. A Z-depth pass from a 3D-rendered scene is labeled Z_PASS. The Channel Booleans node is used to map the Aux Z channel into either the red, green, or blue channel. The Z to World Position node is placed after the Channel Booleans node, and an imported 3D camera that matches the RGBA image is connected to the 3D camera input on the Z to World Position node. A Channel Booleans node is placed after the Z to World Position node, which can remap the X, Y, and Z positions for use in other nodes.
Inspector

The Z to World Position Controls tab

Controls Tab
The Controls tab determines whether you are creating a World Position Pass or a Z channel. If there is more than one camera in the connected scene, this tab also selects the camera to use for the calculation.

Mode
This menu switches between creating a Z channel from a World Position Pass or vice versa.

Camera
If multiple cameras are available in the connected Scene input, this drop-down menu allows you to choose the correct camera needed to evaluate the image.

Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other Position nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

WPP Concept

The Position nodes in Fusion offer an entirely new way of working with masks and Volumetrics for footage containing XYZ Position channels. Z to World offers the option to create those channels out of a Z channel and 3D Camera information. For this overview, we refer to the World Position Pass as WPP.

What Is a WPP?
The WPP interprets each pixel's XYZ position in 3D space as an RGB color value.

For instance, if a pixel sits at 0/0/0, the resulting pixel has an RGB value of 0/0/0 and thus will be black. If the pixel sits at 1/0/0 in the 3D scene, the resulting pixel is entirely red. Of course, if the coordinates of the pixel are something like -60/75/123, WPP interprets those values as RGB color values as well.

Due to the potentially enormous size of a 3D scene, the WPP channel should always be rendered in 32-bit floating point to provide the accuracy needed. The image below shows a 3D rendering of a scene with its center sitting at 0/0/0 in 3D Space and the related WPP. For better visibility, the WPP is normalized in this example.
Different Coordinate Spaces
Rendering WPPs can occur in different Coordinate Spaces. These include World Space, Eye Space, and Object Space. The image below depicts how those different spaces look, although the nodes in Fusion require the WPP rendering to occur in World Space.

The Scene Input
The nodes offer a Scene input, which can either be a 3D camera or a 3D scene containing a camera. While the camera is vital for the Z to World node, Volume Mask and Volume Fog can generate their output without any camera attached or with the camera position set to 0/0/0.

However, connecting a camera that lines up with the original camera the WPP has been rendered from, or setting the camera’s position manually, dramatically improves the accuracy and look of the resulting fog or mask.

The “Invisible Sphere”
The example scene shown so far has an empty background, meaning there is nothing in the scene apart from the ground plane and the cubes.

If applying fog to a scene like that, which is larger than the ground plane, the result will look similar to the “w/o Sphere” example shown below because, with no WPP information outside the ground plane, the resulting value is 0/0/0, and the fog fills that area as well.

To get around that, you can add an invisible bounding sphere to your scene to create “dummy” WPP values to help the Fog node to create the correct volume as shown in the “with Sphere” example below.
The Common Controls

Nodes that handle Position operations share several identical controls in the Inspector. This section describes controls that are common among Position nodes.

Inspector

![Position nodes Common Settings tab]

Settings Tab

The Settings tab in the Inspector can be found on every tool in the Position category. The controls are consistent and work the same way for each tool.

**Blend**

The Blend control is used to blend between the tool's original image input and the tool's final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming image. Normally, this will cause the tool to skip processing entirely, copying the input straight to the output.

**Process When Blend Is 0.0**

The tool is processed even when the input value is zero. This can be useful if the node is scripted to trigger a task, but the node's value is set to 0.0.

**Red/Green/Blue/Alpha Channel Selector**

These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.

For example, if the Red button on a Blur tool is deselected, the blur will first be applied to the image, and then the red channel from the original input will be copied back over the red channel of the result.
There are some exceptions, such as tools for which deselecting these channels causes the tool to skip processing that channel entirely. Tools that do this will generally possess a set of identical RGBA buttons on the Controls tab in the tool. In this case, the buttons in the Settings and the Controls tabs are identical.

**Apply Mask Inverted**
Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

**Multiply by Mask**
Selecting this option will cause the RGB values of the masked image to be multiplied by the mask channel’s values. This will cause all pixels of the image not included in the mask (i.e., set to 0) to become black/transparent.

**Use Object/Use Material (Checkboxes)**
Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports Object and Material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels will be used if present. The specific Material ID or Object ID affected is chosen using the next set of controls.

**Correct Edges**
This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option is disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information on the Coverage and Background Color channels, see Chapter 18, “Understanding Image Channels and Node Processing” in the Fusion Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.

**Object ID/Material ID (Sliders)**
Use these sliders to select which ID will be used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker: to grab IDs from the image displayed in the viewer. The image or sequence must have been rendered from a 3D software package with those channels included.

**Motion Blur**
- **Motion Blur**: This toggles the rendering of Motion Blur on the tool. When this control is toggled on, the tool’s predicted motion is used to produce the motion blur caused by the virtual camera’s shutter. When the control is toggled off, no motion blur is created.
- **Quality**: Quality determines the number of samples used to create the blur. A quality setting of 2 will cause Fusion to create two samples to either side of an object’s actual motion. Larger values produce smoother results but increase the render time.
- **Shutter Angle**: Shutter Angle controls the angle of the virtual shutter used to produce the motion blur effect. Larger angles create more blur but increase the render times. A value of 360 is the equivalent of having the shutter open for one full frame exposure. Higher values are possible and can be used to create interesting effects.
- **Center Bias**: Center Bias modifies the position of the center of the motion blur. This allows for the creation of motion trail effects.
- **Sample Spread**: Adjusting this control modifies the weighting given to each sample. This affects the brightness of the samples.
Use GPU
The Use GPU menu has three settings. Setting the menu to Disable turns off GPU hardware-accelerated rendering. Enabled uses the GPU hardware for rendering the node. Auto uses a capable GPU if one is available and falls back to software rendering when a capable GPU is not available.

Hide Incoming Connections
Enabling this checkbox can hide connection lines from incoming nodes, making a node tree appear cleaner and easier to read. When enabled, empty fields for each input on a node will be displayed in the Inspector. Dragging a connected node from the node tree into the field will hide that incoming connection line as long as the node is not selected in the node tree. When the node is selected in the node tree, the line will reappear.

Comments
The Comments field is used to add notes to a tool. Click in the empty field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

Scripts
Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
Chapter 115

Resolve Connect

This chapter details the single node found in the Resolve Connect category, available only in standalone Fusion Studio.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

External Matte Saver [EMS] 2275
External Matte Saver [EMS]

The External Matte Saver node

NOTE: The Resolve Connect category and External Matte Saver node are available only in Fusion Studio.

External Matte Saver Node Introduction

The External Matte Saver node renders multiple mattes into multiple channels of an EXR file. This file is intended to import into DaVinci Resolve’s Color page as an efficient way to deliver multiple mattes for color grading. To perform the same operation with a traditional Saver node, a Channel Boolean is needed to place each matte into a channel, and then name that channel in the Saver. It requires a bit more of a set up. This node streamlines the process by providing multiple inputs and naming the channel based on the node.

Inputs

By default, the node provides a single input for a 2D image you want to save as a matte.

- **Input:** Although initially there is only a single orange input for a matte to connect, the Inspector provides an Add button for adding additional inputs. Each input uses a new color, but all accept 2D RGBA images.

Basic Node Setup

The External Matte Saver node can be placed at the end of any node tree branch for saving mattes. Below, it is connected to the Delta Keyer as well as three other mattes. Each matte beyond the initial one is connected by clicking the Add button in the Inspector first, and then a new input is provided on the node.
Inspector

The External Matte Saver Controls tab

Controls Tab
The Controls tab is used to name the saved file and determine where on your hard drive the file is stored.

Filename
Enter the name you want to use for the EXR file in the Filename field. At the end of the name, append the .exr extension to ensure that the file is saved as an EXR file.

Browse
Clicking the Browse button opens a standard file browser window where you can select the location to save the file.

The External Matte Saver Mattes tab

Mattes Tab
The Mattes tab is where you set up the number of mattes saved in the file, the name for each channel, and the RGBA channels saved from each input.

Channels menu
The Channels menu allows you to select which channels are saved in the matte. You can choose the alpha channel, the RGB channels, or the RGBA channels.

Channels Name
The Channels Name field allows you to customize the name of the matte channel you are saving. This name is displayed in DaVinci Resolve’s Color page.

Node Name
The Node Name field displays the source of the matte. This is automatically populated when you connect a node to the input.

Add
Clicking the Add button adds an input on the node and another set of fields for you to configure and name the new matte channel.
Settings Tab

The Settings Tab in the Inspector is similar to settings found in the Saver tool. The controls are consistent and work the same way as the Settings in other tools.

Blend

The Blend control is used to blend between the tool’s original image input and the tool’s final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming image. Normally, this causes the tool to skip processing entirely, copying the input straight to the output.

Process When Blend Is 0.0

The tool is processed even when the input value is zero. This can be useful if processing of this node is scripted to trigger another task, but the value of the node is set to 0.0.

Red/Green/Blue/Alpha Channel Selector

These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.

For example, if the Red button on a Blur tool is deselected, the blur is first applied to the image, and then the red channel from the original input is copied back over the red channel of the result.

There are some exceptions, such as tools for which deselecting these channels causes the tool to skip processing that channel entirely. Tools that do this generally possess a set of identical RGBA buttons on the Controls tab in the tool. In this case, the buttons in the Settings and the Controls tabs are identical.
Apply Mask Inverted
Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

Multiply by Mask
Selecting this option causes the RGB values of the masked image to be multiplied by the mask channel's values. This causes all pixels of the image not included in the mask (i.e., set to 0) to become black/transparent.

Use Object/Use Material (Checkboxes)
Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports Object ID and Material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels are used, if present. The specific Material ID or Object ID affected is chosen using the next set of controls.

Correct Edges
This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option is disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information on the Coverage and Background Color channels, see Chapter 18, “Understanding Image Channels and Node Processing” in the Fusion Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.

Object ID/Material ID (Sliders)
Use these sliders to select which ID is used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker: to grab IDs from the image displayed in the viewer. The image or sequence must have been rendered from a 3D software package with those channels included.

Motion Blur
– Motion Blur: This toggles the rendering of Motion Blur on the tool. When this control is toggled on, the tool’s predicted motion is used to produce the motion blur caused by the virtual camera’s shutter. When the control is toggled off, no motion blur is created.
– Quality: Quality determines the number of samples used to create the blur. A quality setting of 2 causes Fusion to create two samples to either side of an object’s actual motion. Larger values produce smoother results but increase the render time.
– Shutter Angle: Shutter Angle controls the angle of the virtual shutter used to produce the motion blur effect. Larger angles create more blur but increase the render times. A value of 360 is the equivalent of having the shutter open for one full frame exposure. Higher values are possible and can be used to create interesting effects.
– Center Bias: Center Bias modifies the position of the center of the motion blur. This allows for the creation of motion trail effects.
– Sample Spread: Adjusting this control modifies the weighting given to each sample. This affects the brightness of the samples.
**Hide Incoming Connections**
Enabling this checkbox can hide connection lines from incoming nodes, making a node tree appear cleaner and easier to read. When enabled, empty fields for each input on a node will be displayed in the Inspector. Dragging a connected node from the node tree into the field will hide that incoming connection line as long as the node is not selected in the node tree. When the node is selected in the node tree, the line will reappear.

**Comments**
The Comments field is used to add notes to a tool. Click in the empty field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

**Scripts**
Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
Chapter 116

Shape Nodes

This chapter details the Shape nodes available in Fusion.

Contents

sBoolean 2281
sDuplicate 2284
sEllipse 2286
sExpand 2289
sGrid 2290
sJitter 2291
sMerge 2293
sNGon 2294
sOutline 2297
sRectangle 2299
sRender 2302
sStar 2304
sTransform 2307
Common Controls 2309
The *sBoolean* node combines or excludes overlapping areas of two shapes based on a menu of boolean operations. Like almost all shape nodes, you can only view the *sBoolean* node’s results through a *sRender* node.

### External Inputs

The following inputs appear on the node’s tile in the Node Editor. Except when using the subtract boolean operation, which shape you connect into which input does not matter.

- **Input 1**: [orange, required] This input accepts the output of another shape node. This input is used as the base shape when the subtract boolean operation is chosen.
- **Input 2**: [green, optional] This input accepts the output of another shape node. This input is used to cut the base shape hole when the subtract boolean operation is chosen.

### Basic Node Setup

The *sBoolean* node is used to combine two shape nodes. The output of the *sBoolean* can then be output to another shape node or a *sRender* node for viewing.

Star and ellipse shapes combined in an *sBoolean* node, then output to an *sRender* for viewing and further processing.

### Inspector

The *sBoolean* Controls tab
**Controls**

The Controls tab is primarily used to select the boolean operation that determines how the two shapes are combined.

**Operation**

The operation menu includes four boolean operations:

- **Intersection:** Sometimes called an AND operation, this setting will only show areas where the two shapes overlap. The result is only where input 1 AND input 2 overlap.

  ![Star and ellipse shapes with an sBoolean node set to intersection](image)

- **Union:** Sometimes called an OR operation, this setting will only show areas where either of the two shapes exists. The result is where either input 1 OR input 2 exists. The Union setting is similar to the result of the sMerge node.

  ![Star and ellipse shapes with an sBoolean node set to union](image)

- **Subtract:** Sometimes called a NOT operation, this setting outputs the shape of input 1 but eliminates the areas where input 2 overlaps. The result is input 1 minus input 2.

  ![Star and ellipse shapes with an sBoolean node set to subtract](image)

- **Xor:** Sometimes called an AND NOT operation, this setting outputs the shape of input 1 or input 2 but eliminates the areas where they overlap. The result is (input 1 minus input 2) + (input 2 minus input 1).

  ![Star and ellipse shapes with an sBoolean node set to subtract](image)
Style Mode

The Style mode menu only includes one option. The Replace setting replaces the color and alpha level of the incoming shapes with the color set in the Style tab.

Style Tab

The sBoolean Style tab

Style

Any color assigned to the individual shape nodes is replaced by the color set using the Style tab controls.

Color

The color controls determine the color of the output shape from the sBoolean node. To choose a shape color, you can click the color disclosure arrow, use the color swatch, or drag the eyedropper into the viewer to select a color from an image. The RGBA sliders or number fields can be used to enter each color channel’s value or the strength of the alpha channel.

Allow Combining

When this checkbox is enabled, the alpha channel value is maintained even when passing through other nodes downstream that may cause the shape to overlap with copies of itself. When disabled, the alpha channel value may increase when the shape overlaps itself.

For instance, if an ellipse’s alpha channel is set to .5, enabling the Allow Combining checkbox maintains that value even if the shape passes through a duplicate or grid node that causes the shape to overlap. Disabling the checkbox causes the alpha channel values to be compounded at each
overlapping area. When using the sBoolean node, the individual shape node checkboxes are ignored, and the sBoolean node’s checkbox determines the alpha channel’s behavior.

Common Controls

Settings tab
The Settings tab in the Inspector is common to all Shape nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

sDuplicate

The sDuplicate node creates copies of the input shape, offsetting each copy’s position, size, and rotation. Like almost all shape nodes, you can only view the sDuplicate node’s results through a sRender node.

External Inputs
The following input appears on the node’s tile in the Node Editor:

- Input: [orange, required] This input accepts the output of another Shape node. The shape connected to this input is copied and offset based on the controls in the Inspector.

Basic Node Setup
The sDuplicate node takes a single input that is most often from a single or compound shape from a sMerge or sBoolean node. The sDuplicate node creates copies of the incoming shape and offsets them to create a pattern. The output of the sDuplicate can then be output to another shape node or to a sRender node for viewing or compositing into the greater node tree.
Controls

The Controls tab is used to determine the number of copies and set their position, size, and rotation offset.

Copies

This slider determines the number of copies created by the node. The number does not include the original shape, so entering a value of five will produce five copies plus the original.

X and Y Offset

These sliders set the X and Y distance between each of the copies. Each copy is offset from the previous copy by the value entered in the X and Y number fields. The copies all start at 0, the center of the original shape, and are offset from there. Using Fusion’s normalized coordinate system, entering X Offset at 0.5 would move each copy half the frame’s width to the right. Entering -1.0 would move each copy to the left by the width of the frame.

X and Y Size

Sets the X and Y size offset based on the previous shape size. For instance, an X and Y value of 1.0 creates copies identical in size to the original but. Entering a value of X and Y of 0.5 will cause each copy to be half the size of the copy before it.

Axis Mode

The Axis mode menu provides four options for determining how each copy determines its rotational pivot point.

- Absolute: Allows you to set an X and Y position for the axis of rotation based on the original shape’s location. The axis of rotation is then copied and offset with each duplicated shape.
- Origin Relative: Each copy uses its center point as its axis of rotation.
- Origin Absolute: Each copy uses the center of the original shape as its axis of rotation.
- Progressive: Compounds each shape copy by progressively transforming each copy based on the previous shape’s position, rotation, and scale.

X and Y Pivot

The X and Y pivot controls are displayed when the Axis mode is set to Absolute. You can use these position controls to place the axis of rotation.

Rotation

Determines an offset rotation applied to each copy. The rotation is calculated from the offset rotation of the previous copy. To rotate all copies identically, use the Angle parameter on the original shape or use a sTransform node.
Common Controls

Settings tab
The Settings tab in the Inspector is common to all Shape nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

sEllipse

The sEllipse node is used to create circular shapes. Like almost all shape nodes, you can only view the sEllipse node’s results through a sRender node.

External Inputs
This node generates shapes and does not have any inputs.

Basic Node Setup
The sEllipse node is a shape generator, meaning it generates a shape and therefore has no input. The output of the sEllipse can go into a sRender for viewing and further compositing or, more likely, connect to another shape node like sGrid or sDuplicate.

Inspector

The sEllipse Controls tab
Controls
The Controls tab is used to define the elliptical shape characteristics, including fill, border, size, and position.

Solid
When enabled, the Solid checkbox fills the elliptical shape with the color defined in the Style tab. When disabled, an outline created by the Border Width control is displayed, and the center is made transparent.

Border Width
This parameter expands or contracts the border around the shape. Although it can be used when the Solid checkbox is enabled, it is primarily used to determine the outline thickness when the checkbox is disabled.

Cap style
When the Solid checkbox is disabled, three cap style options are displayed. The cap styles can create lines with flat, rounded, or squared ends. Flat caps have flat, squared ends, while rounded caps have semi-circular ends. Squared caps have projecting ends that extend half the line width beyond the end of the line.

The caps are not visible unless the length is below 1.0.

Position
The position parameter is only displayed when the Solid checkbox is disabled. It allows you to position the starting point of the shape. When used in conjunction with the length parameter, it positions the gap in the ellipse outline.

Length
The length parameter is only displayed when the Solid checkbox is disabled. A length of 1.0 is a closed shape. Setting the length below 1.0 creates an opening or gap in the outline. Keyframing the length parameters allows you to create write-on style animations.

X and Y Offset
These parameters are used to position the shape left, right, up, and down in the frame. The shape starts in the center of the frame, and the parameters are used to offset the position. The offset coordinates are normalized based on the width of the frame. An X offset of 0.0 is centered, and a value of 0.5 places the center of the shape directly on the right edge of the frame.

Width/Height
The width and height determine the vertical and horizontal size of the ellipse. If the values are identical, then you have a perfect circle.

Angle
The angle rotates the shape, which on a perfect circle doesn’t change the image all that much, but if you create an oval or an outline with a short length, you can rotate the shape based on the center axis.
Style Tab

The sEllipse Style tab

Style

The Style tab is used to assign a color to the shape and control its transparency.

Color

The color controls determine the color of the fill and border. To choose a shape color, you can click the color disclosure arrow, use the color swatch, or drag the eyedropper into the viewer to select a color from an image. The RGBA sliders or number fields can be used to enter each color channel's value or the strength of the alpha channel.

Allow Combining

When this checkbox is enabled, the alpha channel value is maintained even when passing through other nodes downstream that may cause the shape to overlap with copies of itself. When disabled, the alpha channel value may increase when the shape overlaps itself.

For instance, if an ellipse's alpha channel is set to .5, enabling the Allow Combining checkbox maintains that value even if the shape passes through a Duplicate or Grid node that causes the shape to overlap. Disabling the checkbox causes the alpha channel values to be compounded at each overlapping area.

Common Controls

Settings tab

The Settings tab in the Inspector is common to all Shape nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.
sExpand

The sExpand node is used to dilate or erode shapes. Like almost all Shape nodes, you can only view the sExpand node’s results through a sRender node.

External Inputs

The following input appears on the node’s tile in the Node Editor.

- **Input**: [orange, required] This input accepts the output of another shape node. This shape or compound shape connected to this input is either eroded or dilated.

Basic Node Setup

The sExpand node takes a single input that is most often from a compound shape. However, it can be used on single shapes like sStars and sNgons. The output of the sExpand can then be output to another shape node or to a sRender node for viewing or compositing into the greater node tree.

Inspector

The sExpand Controls tab

Controls

The Controls tab includes all of the parameters for the sExpand node.

**Amount**

A positive value dilates the shape while a negative value erodes it.
Border Style
The border style controls how the expanded or contracted shapes join at the corners. There are four styles provided as options. Bevel squares off the corners. Round creates rounded corners. Miter and Miter Clip maintain pointed edges, until a certain threshold. The Threshold is set by the Miter limit slider.

Miter Limit
The Miter parameter is only displayed when the Miter or Miter Clip border style is selected. The miter limit determines when the pointed edges become beveled based on the shape's thickness.

Common Controls
Settings tab
The Settings tab in the Inspector is common to all Shape nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

sGrid
The sGrid node replicates the shape on an X and Y grid and adds the ability to offset the rows and columns. Like almost all Shape nodes, you can only view the sGrid node’s results through a sRender node.

External Inputs
The following input appears on the node’s tile in the Node Editor.
- Input: [orange, required] This input accepts the output of another Shape node. The shape connected to this input is replicated on a custom grid.

Basic Node Setup
The sGrid node takes a single input from a single or compound shape from an sMerge or sBoolean node. The sGrid node places the incoming shape on a grid of rows and columns. The output of the sGrid can then be output to another Shape node or a sRender node for viewing or compositing into the greater node tree.
Controls

The Controls tab is used to determine the number of grid cells and their offset position.

*Grid Cells X and Y*

These parameters set the number of cells on the grid, both horizontally and vertically. For instance, entering 5 in the X and Y number field creates five rows of the shape and five columns.

*X and Y Offset*

Sets the X and Y distance between the rows and columns. An offset value of 0.0 will have all the rows and columns on top of each other. Entering X Offset at 1.0 would spread the columns the width to the frame.

Common Controls

**Settings tab**

The Settings tab in the Inspector is common to all Shape nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

sJitter

The sJitter node is most often used to randomly position an array of shapes generated from a sGrid or sDuplicate node. However, it includes an auto-animating random mode that can be used to distort and randomly jitter single shapes.

Like almost all Shape nodes, you can only view the sJitter node’s results through a sRender node.

External Inputs

The following input appears on the node’s tile in the Node Editor.

- **Input**: [orange, required] This input accepts the output of another Shape node. The shape connected to this input is offset, distorted, and animated based on the sJitter node settings.
Basic Node Setup

The sJitter node takes an array of shapes from a sGrid or sDuplicate node and randomly changes their position, size, and rotation. The output of the sExpand can then be output to another Shape node or to a sRender node for viewing or compositing into the greater node tree.

An array of shapes created by the sGrid node input into an sJitter node to randomly offset or scale the shapes

Inspector

The sJitter Controls tab

Controls

The Controls tab offers range sliders that determine the variation amount for offset, size, and rotation. The Point Jitter parameters are used to offset the invisible points that create the vector shapes.

Jitter Mode

The Jitter Mode menu allows you to choose between static position and size offsets or enabling an auto-animation mode. Leaving the default Fixed selection allows you to offset a grid of shapes, animating with keyframes or modifiers if needed. The Random menu selection auto-animates the parameters based on the range you define using the range sliders. If all the range sliders are left in the default position, no random animation is created. Increasing the range on any given parameter will randomly animate that parameter between the range slider values.

Shape X and Y Offset

These parameters set the horizontal and vertical offset from the shape array’s original position. This is done randomly, so not all shapes in the array will offset by the same amount.
**Shape X and Y Size**
These parameters set the horizontal and vertical scaling for each shape in an array. The left range value decreases the scale, and the right range value increases the scale. This is done randomly, so not all shapes in the array will scale by the same amount.

**Shape Rotate**
This parameter rotates each shape in an array.

**Point Jitter**
The X and Y Point Jitter parameters use the vector control points to distort the shape. This can be used to give a distressed appearance to ellipses or wobbly animation to other shapes.

**Common Controls**

**Settings tab**
The Settings tab in the Inspector is common to all Shape nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

---

**sMerge**

The sMerge node combines shapes similar to a standard Merge node, except the sMerge node can accept more than two shape inputs.

Like almost all Shape nodes, you can only view the sMerge node’s results through a sRender node.

**External Inputs**
The node displays only two inputs first, but as each shape node is connected, a new input appears on the node, assuring there is always one free to add a new shape into the composite.

- **Input[#]**: These multi-colored inputs are used to connect multiple Shape node. There is no limit to the number of inputs this node can accept. The node dynamically adds more inputs as needed, ensuring that there is always at least one input available.

**Basic Node Setup**
The sMerge node is used to combine two Shape nodes. In terms of layering, each subsequent input is placed over the previous input. For instance, the first shape connected to the orange input is the bottom-most shape, the green input is layered over it, and if a third shape is connected to the pink input, that is the topmost layer.
Three shapes are combined in an sMerge node, then output to an sRender for viewing and further processing.

**Inspector**

The sMerge Controls tab

**Controls**
The only control for the sMerge node is the Override Axis checkbox, which overrides the shape’s axis.

**Common Controls**

**Settings tab**
The Settings tab in the Inspector is common to all Shape nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

**sNGon**

The sNGon node

The sNGon node is used to create multi-sided shapes like triangles, pentagons, and octagons. Like almost all Shape nodes, you can only view the sNGon node’s results through a sRender node.

**External Inputs**
This node generates shapes and does not have any inputs.

**Basic Node Setup**
The sNGon node is a shape generator, meaning it generates a shape and therefore has no inputs. The output of the sNGon can go into a sRender for viewing and further compositing or, more likely, connect to another Shape node like sGrid or sDuplicate.
Inspector

The sNGon Controls tab

Controls
The Controls tab is used to define multi-sided shape characteristics, including fill, border, size, and position.

Solid
When enabled, the Solid checkbox fills the NGon shape with the color defined in the Style tab. When disabled, an outline created by the Border Width control is displayed, and the center is made transparent.

Border Width
This parameter expands or contracts the border around the shape. Although it can be used when the Solid checkbox is enabled, it is primarily used to determine the outline thickness when the checkbox is disabled.

Border Style
The Border Style parameter controls how the sides of the NGon join at the corners. There are three styles provided as options. Bevel squares off the corners. Round creates rounded corners. Miter maintains pointed corners.

Cap style
When the Solid checkbox is disabled, three cap style options are displayed. The cap styles can create lines with flat, rounded, or squared ends. Flat caps have flat, squared ends, while rounded caps have semi-circular ends. Squared caps have projecting ends that extend half the line width beyond the end of the line.

The caps are not visible unless the length is below 1.0.
**Position**
The Position parameter is only displayed when the Solid checkbox is disabled. It allows you to position the starting point of the shape. When used in conjunction with the Length parameter, it positions the gap in the outline.

**Length**
The Length parameter is only displayed when the Solid checkbox is disabled. A length of 1.0 is a closed shape. Setting the length below 1.0 creates an opening or gap in the outline. Keyframing the Length parameters allows you to create write-on style animations.

**X and Y Offset**
These parameters are used to position the shape left, right, up, and down in the frame. The shape starts in the center of the frame, and the parameters are used to offset the position. The offset coordinates are normalized based on the width of the frame. So, an X offset of 0.0 is centered and a value of 0.5 places the center of the shape directly on the right edge of the frame.

**Width/Height**
The Width and Height parameters determine the vertical and horizontal size of the ellipse. If the values are identical, then all sides are of equal length.

**Angle**
The Angle parameter rotates the shape based on the center axis.

**Style Tab**

![The sNGon Style tab](image)

**Style**
The Style tab is used to assign a color to the shape and control its transparency.

**Color**
The Color controls determine the color of the fill and border. To choose a shape color, you can click the color disclosure arrow, use the color swatch, or drag the eyedropper into the viewer to select a color from an image. The RGBA sliders or number fields can be used to enter each color channel’s value or the strength of the alpha channel.
Allow Combining

When this checkbox is enabled, the alpha channel value is maintained even when passing through other nodes downstream that may cause the shape to overlap with copies of itself. When disabled, the alpha channel value may increase when the shape overlaps itself.

For instance, if a NGon alpha channel is set to .5, enabling the Allow Combining checkbox maintains that value even if the shape passes through a duplicate or grid node that causes the shape to overlap. Disabling the checkbox causes the alpha channel values to be compounded at each overlapping area.

Settings tab

The Settings tab in the Inspector is common to all Shape nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

sOutline

The sOutline node is used to create outlines from merged or boolean compound shapes. The individual shapes retain their own style, color, size, position, and other characteristics. The only difference is the border thickness, border style, position, and length are applied to all incoming shapes uniformly in the sOutline node.

Like almost all shape nodes, you can only view the sOutline node’s results through a sRender node.

External Inputs

The following input appears on the node’s tile in the Node Editor:

- **Input**: [orange, required] This input accepts the another shape node’s output, but more likely a compound shape from a sMerge or sBoolean. An outline is created from the compound shape connected to this input.

Basic Node Setup

The sOutline node takes a single input that is most often from a compound shape, however, it can sometimes be useful on single shapes to create double outlines. The output of the sOutline can then be output to another Shape node or to a sRender node for viewing or compositing into the greater node tree.
A compound shape from an sBoolean node is connected to an sOutline for creating a complex outlined shape

Inspector

The sOutline Controls tab

Controls
The Controls tab is used to define the outline thickness, border and cap style, position, and length that is applied to the compound shape connected to the input.

Thickness
This parameter controls the width of the outline.

Border Style
The Border Style parameter controls how the outline joins at the corners. There are three styles provided as options. Bevel squares off the corners. Round creates rounded corners. Miter maintains pointed corners.

Cap style
Three Cap Style options are used to create lines with flat, rounded, or squared ends. Flat caps have flat, squared ends, while rounded caps have semi-circular ends. Squared caps have projecting ends that extend half the line width beyond the end of the line.

The caps are not visible unless the length is below 1.0.

Position
The Position parameter allows you to position the starting point of the shape. When used in conjunction with the Length parameter, it positions the gap in the outline.

Length
The Length parameter controls the end position of the outline. A length of 1.0 is a closed shape. Setting the length below 1.0 creates an opening or gap in the outline. Keyframing the Length parameters allows you to create write-on style animations.
Common Controls

Settings tab
The Settings tab in the Inspector is common to all Shape nodes. These common controls are
described in detail at the end of this chapter in “The Common Controls” section.

sRectangle

The sRectangle node

The sRectangle node is used to create rectangular shapes. Like almost all shape nodes, you can only
view the sRectangle node’s results through a sRender node.

External Inputs
This node generates shapes and does not have any inputs.

Basic Node Setup
The sRectangle node is a shape generator, meaning it generates a shape and therefore has no inputs.
The output of the sRectangle can go into a sRender for viewing and further compositing or, more likely,
connect to another Shape node like sGrid or sDuplicate.

Inspector

The sRectangle Controls tab
Controls
The Controls tab is used to define the rectangle characteristics, including fill, border, size, and position.

Solid
When enabled, the Solid checkbox fills the rectangle shape with the color defined in the Style tab. When disabled, an outline created by the Border Width control is displayed, and the center is made transparent.

Border Width
This parameter expands or contracts the border around the shape. Although it can be used when the Solid checkbox is enabled, it is primarily used to determine the outline thickness when the checkbox is disabled.

Border Style
The Border Style parameter controls how the sides of the rectangle join at the corners. There are three styles provided as options. Bevel squares off the corners. Round creates rounded corners. Miter maintains pointed corners.

Cap style
When the Solid checkbox is disabled, three Cap Style options are displayed. The cap styles can create lines with flat, rounded or squared ends. Flat caps have flat, squared ends, while rounded caps have semi-circular ends. Squared caps have projecting ends that extend half the line width beyond the end of the line.

Position
The Position parameter is only displayed when the Solid checkbox is disabled. It allows you to position the starting point of the shape. When used in conjunction with the Length parameter, it positions the gap in the outline.

Length
The Length parameter is only displayed when the Solid checkbox is disabled. A length of 1.0 is a closed shape. Setting the length below 1.0 creates an opening or gap in the outline. Keyframing the Length parameters allows you to create write-on style animations.

X and Y Offset
These parameters are used to position the shape left, right, up, and down in the frame. The shape starts in the center of the frame, and the parameters are used to offset the position. The offset coordinates are normalized based on the width of the frame. So an X offset of 0.0 is centered and a value of 0.5 places the center of the shape directly on the right edge of the frame.

Width/Height
The Width and Height parameters determine the vertical and horizontal size of the rectangle. If the values are identical, then you have a square.

Corner Radius
This parameter determines if the corners of the rectangle are sharp or rounded. A value of 0.0 produces sharp corners, while a value of 1.0 will create a circle from a starting square shape or a pill shape from a rectangle.

Angle
The Angle parameter rotates the shape based on the center axis.
Style Tab

The sRectangle Style tab

Style

The Style tab is used to assign color to the shape and control its transparency.

Color

The Color parameter controls determine the color of the fill and border from the sRectangle node. To choose a shape color, you can click the color disclosure arrow and use the color swatch, or drag the eye dropper into the viewer to select a color from an image. The RGBA sliders or number fields can be used to enter the value of each color channel or the strength of the alpha channel.

Allow Combining

When this checkbox is enabled, the alpha channel value is maintained even when passing through other nodes downstream that may cause the shape to overlap with copies of itself. When disabled, the alpha channel value may increase when the shape overlaps itself. For instance, if a rectangle alpha channel is set to .5, enabling the Allow Combining checkbox maintains that value even if the shape passes through a duplicate or grid node that causes the shape and alpha channel to overlap. Disabling the checkbox causes the alpha channel values to be compounded at each overlapping area.

Common Controls

Settings tab

The Settings tab in the Inspector is common to all Shape nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
sRender

The sRender node converts the vector shapes to an image. The output of the sRender allows the vector shapes to be integrated with other elements in a composite.

Inputs

There is one input on the Background node for an Effect Mask input.

- **Input1**: [orange, required] This input accepts the output of your final shape node. A rendered bitmap image is created from the sRender node for composting into the rest of your comp.

- **Effect Mask**: The optional blue effect mask input accepts a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the displayed area to only those pixels within the mask.

Basic Node Setup

The sRender node is always placed at the end of a string of Shape nodes. The output connects to other 2D nodes like a Soft Glow node.
The sRender Image tab

Image Tab
The controls in this tab are used to set the resolution, color depth, and pixel aspect of the image produced by the sRender node.

Process Mode
Use this menu control to select the Fields Processing mode used by Fusion to render the resulting image. The default Full Frames option is appropriate for progressive formats.

Width/Height
This pair of controls are used to set the Width and Height dimensions of the image to be created by the sRender node.

Pixel Aspect
This control is used to specify the Pixel Aspect ratio of the created images. An aspect ratio of 1:1 would generate a square pixel with the same dimensions on either side (like a computer display monitor), and an aspect of 0.9:1 would create a slightly rectangular pixel (like an NTSC monitor).

**NOTE:** Right-click on the Width, Height, or Pixel Aspect controls to display a menu listing the file formats defined in the preferences Frame Format tab. Selecting any of the listed options will set the width, height, and pixel aspect to the values for that format, accordingly.

Auto Resolution
When this checkbox is selected, the width, height, and pixel aspect of the image created by the node will be locked to values defined in the composition’s Frame Format preferences. If the Frame Format preferences change, the resolution of the image produced by the node will change to match. Disabling this option can be useful to build a composition at a different resolution than the eventual target resolution for the final render.

Depth
The Depth button array is used to set the pixel color depth of the image created by the Creator node. 32-bit pixels require 4X the memory of 8-bit pixels but have far greater color accuracy. Float pixels allow high dynamic range values outside the normal 0..1 range, for representing colors that are brighter than white or darker than black.
Source Color Space
You can use the Source Color Space menu to set the Color Space of the footage to help achieve a linear workflow. Unlike the Gamut tool, this doesn’t perform any actual color space conversion, but rather adds the source space data into the metadata, if that metadata doesn’t exist. The metadata can then be used downstream by a Gamut tool with the From Image option, or in a Saver, if explicit output spaces are defined there. There are two options to choose from:

– **Auto:** Automatically reads and passes on the metadata that may be in the image.
– **Space:** Displays a Color Space Type menu where you can choose the correct color space of the image.

Source Gamma Space
Using the Curve Type menu, you can set the Gamma Space of the footage and choose to remove it by way of the Remove Curve check box when working in a linear workflow. There are three choices in the Curve Type menu

– **Auto:** Automatically reads and passes on the metadata that may be in the image.
– **Space:** Displays a Gamma Space Type menu where you can choose the correct gamma curve of the image.
– **Log:** Brings up the Log/Lin settings, similar to the Cineon tool. For more information, see Chapter 38, “Film Nodes” in the Fusion Reference Manual or Chapter 99 in the DaVinci Resolve Reference Manual.

Remove Curve
Depending on the selected Gamma Space or on the Gamma Space found in Auto mode, the Gamma Curve is removed from, or a log-lin conversion is performed on, the material, effectively converting it to a linear output space.

Common Controls

Settings tab
The Settings tab in the Inspector is common to all Shape nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

sStar

The sStar node

The sStar node is used to create multi-point star shapes. Like almost all Shape nodes, you can only view the sStar node’s results through a sRender node.

External Inputs
This node generates shapes and does not have any inputs.
Basic Node Setup

The sStar node is a shape generator, meaning it generates a shape and therefore has no inputs. The output of the sStar can go into a sRender for viewing and further compositing or, more likely, connect to another shape node like sGrid or sDuplicate.

An sStar node connecting to an sDuplicate node, and then viewed using an sRender node

Inspector

The sStar Controls tab

Controls

The Controls tab is used to define the star shape’s characteristics, including number of points, depth, fill, border, size, and position.

Points
This slider determines the number of points or arms on the star.

Depth
The depth slider controls the inner radius or width of the arms. A depth of 0.001 makes hair-thin arms, while a depth of 1.0 makes a faceted circle.

Solid
When enabled, the Solid checkbox fills the star shape with the color defined in the Style tab. When disabled, an outline created by the Border Width control is displayed, and the center is made transparent.

Border Width
This parameter expands or contracts the border around the shape. Although it can be used when the Solid checkbox is enabled, it is primarily used to determine the outline thickness when the checkbox is disabled.
Border Style
The Border Style parameter controls how the sides of the star join at the corners. There are three
styles provided as options. Bevel squares off the corners. Round creates rounded corners. Miter
maintains pointed corners.

Cap style
When the Solid checkbox is disabled, three cap style options are displayed. The cap styles can create
lines with flat, rounded or squared ends. Flat caps have flat, squared ends while rounded caps have
semi-circular ends. Squared caps have projecting ends that extend half the line width beyond the end
of the line.

The caps are not visible unless the length is below 1.0.

Position
The Position parameter is only displayed when the Solid checkbox is disabled. It allows you to position
the starting point of the shape. When used in conjunction with the length parameter, it positions the
gap in the outline.

Length
The Length parameter is only displayed when the Solid checkbox is disabled. A length of 1.0 is a
closed shape. Setting the length below 1.0 creates an opening or gap in the outline. Keyframing the
Length parameters allows you to create write-on style animations.

X and Y Offset
These parameters are used to position the shape left, right, up, and down in the frame. The shape
starts in the center of the frame, and the parameters are used to offset the position. The offset
coordinates are normalized based on the width of the frame. So an X offset of 0.0 is centered and a
value of 0.5 places the center of the shape directly on the right edge of the frame.

Width/Height
The Width and Height parameters determine the vertical and horizontal size of the star. If the values
are identical, then all arms of the star are of equal length.

Angle
The Angle parameter rotates the shape based on the center axis.

Style Tab

![The sStar Style tab]
Style
The Style tab is used to assign color to the shape and control its transparency.

Color
The Color controls determine the color of the fill and border from the sStar node. To choose a shape color, you can click the color disclosure arrow and use the color swatch, or drag the eye dropper into the viewer to select a color from an image. The RGBA sliders or number fields can be used to enter the value of each color channel or the strength of the alpha channel.

Allow Combining
When this checkbox is enabled, the alpha channel value is maintained even when passing through other nodes downstream that may cause the shape to overlap with copies of itself. When disabled, the alpha channel value may increase when the shape overlaps itself. For instance, if a star alpha channel is set to 0.5, enabling the Allow Combining checkbox maintains that value even if the shape passes through a duplicate or grid node that causes the shape and alpha channel to overlap. Disabling the checkbox causes the alpha channel values to be compounded at each overlapping area.

Common Controls

Settings tab
The Settings tab in the Inspector is common to all Shape nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

sTransform

The sTransform node is used to add an additional set of transform controls to the existing controls that are contained in Shape nodes. These additional transforms can be used to create hierarchical animations. For instance, you can use a sStar’s built-in Angle control to spin the star around. The star can then be output to an sTransform node. The rotation control in the sTransform can be used to orbit the star around the frame.

Like almost all Shape nodes, you can only view the sStar node’s results through a sRender node.
**External Inputs**

The following input appears on the node’s tile in the Node Editor:

- **Input**: [orange, required] This input accepts the output of another Shape node. The shape connected to this input is moved, scaled, and rotated based on the sTransform settings.

**Basic Node Setup**

The sTransform node takes the input from another Shape node and adds another set of transforms or hierarchical animation. The output of the sTransform can go into a sRender for viewing and further compositing.

![An sStar node connecting to an sTransform node, and then viewed using an sRender node](image)

**Inspector**

![The sTransform Controls tab](image)

**Controls**

The Controls tab is used to define the add a set of transform controls to the incoming shape.

**X and Y Offset**

These parameters are used to position the shape left, right, up, and down in the frame. The shape starts in the center of the frame, and the parameters are used to offset the position. The offset coordinates are normalized based on the width of the frame. So an X offset of 0.0 is centered and a value of 0.5 places the center of the shape directly on the right edge of the frame.

**X and Y Size**

The X and Y Size determine the vertical and horizontal scaling of the incoming shape. If the values are different then the shape will be skewed from its original design.

**Rotation**

The dial rotates the shape based on the pivot controls.
X and Y Pivot
These parameters position the axis of rotation for the incoming shape. The pivot point is visible in the viewer as a red X. The X can be dragged in the viewer for positioning.

Transform Axis
Check this box to apply the transform to the shape’s axis.

Common Controls

Settings tab
The Settings tab in the Inspector is common to all Shape nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Common Controls

Nodes that handle Shape operations share a number of identical controls in the Inspector. This section describes controls that are common amongst Shape nodes.

Settings Tab
The Settings tab in the Inspector can be found on every Shape node. Most of the controls listed here are only found in the sRender node but a few are common to all Shape nodes.

Blend (sRender only)
The Blend control is used to blend between the tool’s original image input and the tool’s final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming. Normally, this causes the tool to skip processing entirely, copying the input straight to the output.

Process When Blend Is 0.0 (sRender only)
The tool is processed even when the input value is zero. This can be useful if processing of this node is scripted to trigger another task but the value of the node is set to 0.0.

Red/Green/Blue/Alpha Channel Selector (sRender only)
These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.

For example, if the red button on a Blur tool is deselected, the blur is first applied to the image, then the red channel from the original input is copied back over the red channel of the result.

There are some exceptions, such as tools where deselecting these channels causes the tool to skip processing that channel entirely. Tools that do this generally possess a set of identical RGBA buttons on the Controls tab in the tool. In this case, the buttons in the Settings and the Control tabs are identical.

Apply Mask Inverted (sRender only)
Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

Multiply By Mask (sRender only)
Selecting this option causes the RGB values of the masked image to be multiplied by the mask channel’s values. This causes all pixels of the image not included in the mask (i.e., set to 0) to become black/transparent.
Motion Blur (sRender only)

- **Motion Blur**: This toggles the rendering of motion blur on the tool. When this control is toggled on, the tool’s predicted motion is used to produce the motion blur caused by the virtual camera’s shutter. When the control is toggled off, no motion blur is created.

- **Quality**: Quality determines the number of samples used to create the blur. A quality setting of 2 causes Fusion to create two samples to either side of an object’s actual motion. Larger values produce smoother results but increase the render time.

- **Shutter Angle**: Shutter Angle controls the angle of the virtual shutter used to produce the motion blur effect. Larger angles create more blur but increase the render times. A value of 360 is the equivalent of having the shutter open for one whole frame exposure. Higher values are possible and can be used to create interesting effects.

- **Center Bias**: Center Bias modifies the position of the center of the motion blur. This allows for the creation of motion trail effects.

- **Sample Spread**: Adjusting this control modifies the weighting given to each sample. This affects the brightness of the samples.

Use GPU (sRender only)

The user GPU menu has three settings. Setting the menu to Disable turns off hard accelerated rendering using the graphics card in your computer. Auto uses a capable GPU if one is available and falls back to software rendering when a capable GPU is not available.

Hide Incoming Connections

Enabling this checkbox can hide connection lines from incoming nodes, making a node tree appear cleaner and easier to read. When enabled, empty fields for each input on a node will be displayed in the Inspector. Dragging a connected node from the node tree into the empty field will hide that incoming connection line as long as the node is not selected in the node tree. When the node is selected in the node tree the line will reappear.

Comments

The Comments field is used to add notes to a tool. Click in the empty field and type the text. When a note is added to a tool, a small red square appears in the lower left corner of the node when the full tile is displayed or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

Scripts

Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more information on scripting nodes, see the Fusion scripting documentation.
Chapter 117

Stereo Nodes

This chapter details the Stereo nodes available in Fusion. Stereoscopic nodes are available only in Fusion Studio and DaVinci Resolve Studio.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing Medialn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

Anaglyph [Ana] 2312
Combiner [Com] 2315
Disparity [Dis] 2317
Disparity To Z [D2Z] 2320
Global Align [GA] 2324
New Eye [NE] 2326
Splitter [Spl] 2329
Stereo Align [SA] 2330
Z To Disparity [Z2D] 2336
The Common Controls 2339
Anaglyph [Ana]

The Anaglyph node

NOTE: The Anaglyph node is available only in Fusion Studio and DaVinci Resolve Studio.

Anaglyph Node Introduction

The Anaglyph node is used to create stereoscopic images by combining separate left eye and right eye images. It is most commonly used at the end of a stereoscopic workflow to display or deliver the final result.

Inputs

The three inputs on the Anaglyph node are the left eye input, right eye input, and effect mask.

- **Left Eye Input:** The orange input is used to connect the 2D image representing the left eye in the stereo comp.
- **Right Eye Input:** The green input is used to connect the 2D image representing the right eye in the stereo comp.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the stereoscopic creation to only those pixels within the mask.

Basic Node Setup

The Anaglyph node is usually placed at the end of a stereoscopic node tree to display the final result.

When using separate images for the left and right eye, the left eye image is connected to the orange input, and the right eye image is connected to the green input of the node. When using either horizontally or vertically stacked images containing both left eye and right eye information, these only connect to the orange input.
Inspector

The Anaglyph Controls tab

Controls Tab

Using the parameters in the Controls tab, the separate images are combined to create a stereoscopic output.

Color Type Menu

The Color Type menu allows you to choose between different color encodings to fit your preferred display device. To match your stereo glasses, you can choose between Red/Cyan, Red/Green, Red/Blue, Amber/Blue, and Green/Magenta encoding; Red/Cyan is the most commonly used.

Method

In addition to the color used for encoding the image, you can also choose five different methods from the Method menu: Monochrome, Half-color, Color, Optimized, and Dubois. These methods are described below.

– **Monochrome**: Assuming you are using a Red/Cyan Color Type, the left eye contains the luminance of the left image and is placed in the output of the red channel. The right eye contains the luminance of the right image and is placed in the output green and blue channels.
- **Half-Color**: Assuming you are using a Red/Cyan Color Type, the left eye contains the luminance of the left image and is placed in the output of the red channel. The right eye contains the color channels from the right image that match the glasses’ color for that eye.

![Monochrome](image1) ![Half-Color](image2)

- **Color**: The left eye contains the color channels from the left image that match the glasses’ color for that eye. The right eye contains the color channels from the right image that match the glasses’ color for that eye.

- **Optimized**: Used with red/cyan glasses, for example, the resulting brightness of what shows through the left eye is substantially less than the brightness of the right eye. Using typical ITU-R 601 ratios for luminance as a guide, the red eye would give 0.299 brightness, while the cyan eye would give $0.587 + 0.114 = 0.701$ brightness—over twice as bright. The difference in brightness between the eyes can produce what are referred to as retinal rivalry or binocular rivalry, which can destroy the stereo effect. The Optimized method generates the right eye in the same fashion as the Color method. The left eye also uses the green and blue channels but in combination with increased brightness that reduces retinal rivalry. Since it uses the same two channels from each of the source images, it doesn’t reproduce the remaining one. For example, $1.05 \times$ the green and $0.45 \times$ the blue channels of the left image is placed in the red output channel, and the green and blue channels of the right image are placed in the output green and blue channels. Red from both the left and right images is not used.

![Color](image3) ![Optimized](image4)

- **Dubois**: Images with fairly saturated colors can produce retinal rivalry with the Half-color, Color, and Optimized methods because the color is visible in only one eye. For example, with red/cyan glasses, a saturated green object looks black in the red eye, and green in the cyan eye. The Dubois method uses the spectral characteristics of (specifically) red/cyan glasses and CRT (Trinitron) phosphors to produce a better anaglyph and in the end, tends to reduce retinal rivalry caused by such color differences in each eye. It also tends to reduce ghosting produced when one eye ‘leaks’ into the other eye. The particular calculated matrix in Fusion is designed for red/cyan glasses.
cyan glasses and isn’t available for other glasses types. Since it is also derived from CRT color primaries, it may not give the best results with a common LCD (though it’ll still likely produce less retinal rivalry and ghosting than the other methods).

**Swap Eyes**
Allows you to swap the left and right eye inputs easily.

**Horiz Stack**
Takes an image that contains both left and right eye information stacked horizontally. These images are often referred to as “crosseyed” or “straight stereo” images. You only need to connect that one image to the orange input of the node. It then creates an image half the width of the original input, using the left half of the original image for the left eye and the right half of the original image for the right eye. Color encoding takes place using the specified color type and method.

**Vert Stack**
Takes an image that contains both left and right eye information stacked vertically. You only need to connect that one image to the orange input of the node. It then creates an image half the height of the original input, using the bottom half of the original image for the left eye and the top half of the original image for the right eye. Color encoding takes place using the specified color type and method.

**Common Controls**

**Settings Tab**
The Settings tab in the Inspector is also duplicated in other Stereo nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

**Combiner [Com]**

**NOTE:** The Combiner node is available only in Fusion Studio and DaVinci Resolve Studio.
Combiner Node Introduction

The Combiner node takes two stereoscopic inputs and creates so-called “stacked images” with the left and right eye, either side by side or on top of each other. Stereoscopic nodes are available only in Fusion Studio and DaVinci Resolve Studio.

Inputs

The two inputs on the Combiner node are used to connect the two images that get combined in a stacked stereo image.

- **Image 1 Input**: The orange input is used to connect the 2D image representing the left eye in the stereo comp.
- **Image 2 Input**: The green input is used to connect the 2D image representing the right eye in the stereo comp.

Basic Node Setup

Below, a left eye image and right eye image are connected to the Combiner node to create a single stacked stereo image. It can be more efficient to render out the stacked stereo images as EXR files than to generate the disparity on-the-fly.

![Left and right eye images are connected into a Combiner node to generate a stacked stereo image.](image)

Inspector

The Combiner Controls tab

Controls Tab

To stack the images, the left eye image is connected to the orange input, and the right eye image is connected to the green input of the node.

Combine

The Combine menu provides three options for how the two images are made into a stacked stereo image.

- **None**: No operation will take place. The output image is identical to the left eye input.
- **Horiz**: Both images will be stacked horizontally, or side-by-side, with the image connected to the left eye input on the left. This will result in an output image double the width of the input image.
- **Vert**: Both images will be stacked vertically, or on top of each other, with the image connected to the left eye input on the bottom. This will result in an output image double the height of the input image.
Swap Eyes
Allows you to easily swap the left and right eye input.

Add Metadata
Metadata is carried along with the images and can be added to the existing metadata using this checkbox. To view Metadata, use the viewer’s SubView menu set to Metadata.

Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other Stereo nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Disparity [Dis]

The Disparity node

NOTE: The Disparity node is available only in Fusion Studio and DaVinci Resolve Studio.

Disparity Node Introduction
Disparity generates the left/right shift between the frames in a stereo pair. It also generates the vertical disparity between the left/right images, which is usually a lot smaller than the horizontal disparity and ideally should be 0 to minimize viewing discomfort. When viewing the output of the Disparity node in the views, the human eye can distinguish quality/detail in the Disparity map better by looking at either the grayscale X disparity or Y disparity rather than looking at the combined XY disparity as a Red/Green color image.

The generated disparity is stored in the output image’s Disparity aux channel, where the left image contains the left > right disparity, and the right image contains the right > left disparity. Because disparity works based on matching regions in the left eye to regions in the right eye by comparing colors and gradients of colors, colors in the two eyes must be as similar as possible. Thus, it is a good idea to color correct ahead of time. It is also a good idea to crop away any black borders around the frames, as this confuses the disparity tracking (and also causes problems if you are using the Color Corrector’s histogram match ability to do the color matching).

In Stack mode, left and right outputs deliver the same image. If the left and right images have a global vertical offset larger than a few pixels, it can help the disparity tracking algorithm if you vertically align features in the left/right eyes ahead of time using a Transform node. Small details tend to get lost in the tracking process when you have a large vertical offset between left/right eyes.

Consider using a SmoothMotion node to smooth your disparity channel. This can help reduce time-dependent flickering when warping an eye. Also, think about whether you want to remove lens distortion before computing disparity. If you do not, your Disparity map becomes a combined Disparity and Lens Distortion map. This can have advantages and disadvantages.

One disadvantage is that if you then do a vertical alignment, you are also removing lens distortion effects. When trying to reduce the computation time, start first with adjusting the Proxy and Number of Iterations sliders.
The Disparity node does not support RoI or DoD.

**Inputs**
The two inputs on the Disparity node are used to connect the left and right images.
- **Left Input:** The orange input is used to connect either the left eye image or the stacked image.
- **Right Input:** The green input is used to connect the right eye image. This input is available only when the Stack Mode menu is set to Separate.

**Outputs**
Unlike most nodes in Fusion, Disparity has two outputs for the left and right eye.

**Left Output:** This holds the left eye image with a new disparity channel, or a Stacked Mode image with a new disparity channel.

**Right Output:** This holds the right eye image with a new disparity channel. This output is visible only if Stack Mode is set to Separate.

**Basic Node Setup**
Below, a left eye image and right eye image are connected to the Disparity node. The Disparity node then outputs each eye to Saver nodes. It can be more efficient to render out the stereo images as EXR files than to generate the disparity on-the-fly.

![Diagram of Disparity node setup](image)

Left and right eye images are connected into a Disparity node to generate and render out a stereo image.

**Inspector**

The Disparity Controls tab
**Proxy (for Tracking)**

The input images are resized down by the proxy scale, tracked to produce the disparity, and then the resulting disparities are scaled back up. This option is purely to speed up the calculation of the disparity, which can be slow. The computational time is roughly proportional to the number of pixels in the image. This means a proxy scale of 2 gives a 4x speedup, and a proxy scale of 3 gives a 9x speedup. In general, 1:1 proxy will give the most detailed flow, but keep in mind that this is highly dependent on the amount of noise and film grain. If noise is present in large quantities, it can completely obliterate any gains moving from 2:1 to 1:1 proxy. In some situations, it can even make things worse. You can think of the Proxy setting as acting as a simplistic low-pass filter for removing noise/grain.

**Advanced**

The Advanced settings section has parameter controls to tune the Disparity map calculations. The default settings have been chosen to be the best default values from experimentation with many different shots and should serve as a good standard. In most cases, tweaking of the Advanced settings is not needed.

**Smoothness**

This controls the smoothness of the disparity. Higher values help deal with noise, while lower values bring out more detail.

**Edges**

This slider is another control for smoothness but applies it based on the color channel. It tends to have the effect of determining how edges in the disparity follow edges in the color images. When it is set to a lower value, the disparity becomes smoother and tends to overshoot edges. When it is set to a higher value, edges in the disparity align more tightly with the edges in the color images, and details from the color channels start to slip into the disparity, which is not usually desirable.

As a rough guideline, if you are using the disparity to produce a Z channel for post effects like depth of field, experiment with higher values, but if you are using the disparity to do interpolation, you might want to keep the values lower.

In general, if the Edges slider is set is too high, there can be problems with streaked out edges when the disparity is used for interpolation.

**Match Weight**

This controls how matching is done between neighboring pixels in the left image and neighboring pixels in the right image. When a lower value is used, large structural color features are matched. When higher values are used, small sharp variations in the color are matched. Typically, a good value for this slider is in the [0.7, 0.9] range. Setting this option higher tends to improve the matching results in the presence of differences due to smoothly varying shadows or local lighting variations between the left and right images. You should still color match the initial images so they are as similar as possible; this option tends to help with local variations (e.g., lighting differences due to light passing through a mirror rig).

**Mismatch Penalty**

This controls how the penalty for mismatched regions grows as they become more dissimilar. The slider provides a choice between a balance of Quadratic (lower values) and Linear (higher values) penalties. Lower value Quadratic settings strongly penalize large dissimilarities, while higher value Linear settings are more robust to dissimilar matches. Moving this slider toward lower tends to give a disparity with more small random variations in it, while higher values produce smoother, more visually pleasing results.

**Warp Count**

Turning down the Warp Count makes the disparity computations faster. In particular, the computational time depends linearly upon this option. To understand what this option does, you need to understand that the Disparity algorithm progressively warps the left image until it matches with the right image.
After some point, convergence is reached, and additional warps are just a waste of computational time. The default value in Fusion is set high enough that convergence should always be reached. You can tweak this value to speed up the computations, but it is good to watch how the disparity is degrading in quality at the same time.

**Iteration Count**

Turning down the Iteration Count makes the disparity computations faster. In particular, the computational time depends linearly upon this option. Just like adjusting Warp Count, at some point adjusting this option higher will yield diminishing returns and will not produce significantly better results. By default, this value is set to something that should converge for all possible shots and can be tweaked lower fairly often without reducing the disparity’s quality.

**Filtering**

This menu determines the filtering operations used during flow generation. Catmull-Rom filtering will produce better results, but at the same time, it increases the computation time steeply.

**Stack Mode**

This menu determines how the input images are stacked.

When set to Separate, the Right Input and Output will appear, and separate left and right images must be connected.

**Swap Eyes**

Enabling this checkbox causes the left and right images to swap.

**Common Controls**

**Settings Tab**

The Settings tab in the Inspector is also duplicated in other Stereo nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

### Disparity To Z [D2Z]

The DisparityToZ node

**NOTE:** The Disparity to Z node is available only in Fusion Studio and DaVinci Resolve Studio.

### Disparity to Z Node Introduction

Disparity To Z takes a 3D camera and an image containing a disparity channel as inputs, and outputs the same image but with a newly computed Z channel.

Optionally, this node can output Z into the RGB channels. Ideally, either a stereo Camera 3D or a tracked stereo camera is connected into Disparity To Z. However, if no camera is connected, the node provides artistic controls for determining a Z channel. The depth created by this node can be used for post effects like fogging or depth of field (DoF).
The Z values produced become more incorrect the larger (negative) they get. The reason is that disparity approaches a constant value as Z approaches -infinity. So Z = -1000 and Z = -10000 and Z = -100000 may map to D=142. 4563 and D=142. 4712 and D=142. 4713. As you can see, there is only 0.0001 in D to distinguish between 10,000 and 100,000 in Z. The maps produced by disparity are not accurate enough to make distinctions like this.

**Inputs**

The three inputs on the Disparity To Z node are used to connect the left and right images and a camera node.

- **Left Input:** The orange input is used to connect either the left eye image or the stack image.
- **Right Input:** The green input is used to connect the right eye image. This input is available only when the Stack Mode menu is set to Separate.
- **Stereo Camera:** The magenta input is used to connect a stereo camera node.

**Outputs**

Unlike most nodes in Fusion, Disparity To Z has two outputs for the left and right eye.

- **Left Output:** This holds the left eye image with a new Z channel, or a Stacked Mode image with a new disparity channel.
- **Right Output:** This holds the right eye image with a new Z channel. This output is visible only if Stack Mode is set to Separate.

**Basic Node Setup**

Disparity To Z takes a 3D camera and stereo images containing a disparity channel as inputs. The output is an image with a newly computed Z channel.

A Disparity to Z node creates an image with a Z channel.

**Inspector**

The Disparity To Z Controls tab
Controls Tab
In addition to outputting Z values in the Z channel, this tab promotes the color channels to float32 and outputs the Z values into the color channels as \( \{z, z, z, 1\} \). This option is useful to get a quick look at the Z channel.

**NOTE**: Z values are negative, becoming more negative the further you are from the camera. The viewers only show 0.0 to 1.0 color, so to visualize other data it has to be converted via a normalization method to fit in a display 0-1 range. To do this, right-click in the viewer and choose Options > Show Full Color Range.

Output Z to RGB
Rather than keeping the Z values within the associated aux channel only, they will be copied into the RGB channels for further modification with any of Fusion’s nodes.

Refine Z
The Enable checkbox refines the depth map based upon the RGB channels. The refinement causes edges in the flow to align more closely with edges in the color channels. The downside is that unwanted details in the color channels start to show up in the flow. You may want to experiment with using this option to soften out harsh edges for Z-channel post effects like depth of field or fogging.

HiQ Only
Activating this checkbox causes the Refine Z option to process only when rendering is set to High Quality. You can ensure High Quality is enabled by right-clicking to the left or right of the transport controls in the main toolbar.

Strength
Increasing this slider does two things. It smooths out the depth in constant color regions and moves edges in the Z channel to correlate with edges in the RGB channels. Increasing the refinement has the undesirable effect of causing texture in the color channel to show up in the Z channel. You will want to find a balance between the two.

Radius
This is the radius of the smoothing algorithm.

Stack Mode
This menu determines how the input images are stacked. When set to Separate, the Right Input and Output will appear, and separate left and right images must be connected.

Swap Eyes
Enabling this checkbox causes left and right images to be swapped.

The Disparity To Z Camera tab
Camera Tab

If you need correct real-world Z values because you are trying to match some effect to an existing scene, you should use the External Camera options to get precise Z values back. If any Z-buffer will suffice and you are not that particular about the exact details of how it is offset and scaled, or if there is no camera available, the Artistic option might be helpful.

- **External Mode**: An input is available on the node to connect an existing stereo Camera 3D. This can either be a single stereo Camera 3D (i.e., its eye separation is set to non-zero), or a pair of (tracked) Camera 3Ds connected via the Camera 3D > Stereo > Right Camera input.

- **Artistic Mode**: If you do not have a camera, you can adjust these controls to produce an “artistic” Z channel whose values will not be physically correct but will still be useful. To reconstruct the Disparity > Z Curve, pick (D, Z) values for a point in the foreground and a point in the background.

**Tip**: If artistic mode is a little too “artistic” for you and you want more physically-based parameters to adjust (e.g., convergence and eye separation), create a dummy Camera 3D, connect it into the Disparity To Z > Camera input, and then fiddle with the Camera 3D’s controls.

**Foreground Disparity (Pick from Left Eye)**

When the camera Mode is set to Artistic, a Foreground Disparity slider is available. This is the disparity for the closest foreground object. It will get mapped to the depth value specified by the Foreground Depth control. Any objects with disparity outside of the range [ForegroundDisparity, BackgroundDisparity] will have their disparity values clipped to this range leading to flat areas in the Z channel, so make sure that you pick values that enclose the actual disparity range.

**Background Disparity (Pick from Left Eye)**

When the camera Mode is set to Artistic, a Background Disparity is available. This is the disparity for the furthest background object. It will get mapped to the depth value specified by the Background Depth control. One way to think of this input is as the upper limit to disparity values for objects at -infinity. This value should be for the left eye. The corresponding value in the right eye will be the same in magnitude but negative.

**Foreground Depth**

This is the depth to which Foreground Disparity will be mapped. Think of this as the depth of the nearest object. Note that values here are positive depth.

**Background Depth**

This is the depth to which Background Disparity will be mapped. Think of this as the depth of the most distant object.

**Falloff**

Falloff controls the shape of the depth curve between the requested foreground and background depths. When set to Hyperbolic, the disparity-depth curve behaves roughly like depth = constant / disparity. When set to Linear, the curve behaves like depth = constant * disparity. Hyperbolic tends to emphasize Z features in the foreground, while linear gives foreground/background features in the Z channel equal weighting.

Unless there’s a specific reason, choose Hyperbolic, as it is more physically accurate, while Linear does not correspond to nature and is purely for artistic effect.

Common Controls

**Settings Tab**

The Settings tab in the Inspector is also duplicated in other Stereo nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
Global Align [GA]

The GlobalAlign node

NOTE: The Global Align node is available only in Fusion Studio and DaVinci Resolve Studio.

Global Align Node Introduction

As opposed to Stereo Align, this node does not utilize optical flow at all. It’s meant as a fast and convenient way to do simple stereo alignment for both X and Y as well as rotation.

Global Align comes in handy at the beginning of the node chain to visually correct major differences between the left and right eye before calculating Disparity.

Manual correction of large discrepancies between left and right, as well as applying an initial color matching, helps Disparity generate more accurate results.

Inputs

The two inputs on the Global Align node are used to connect the left and right images.

– Left Input: The orange input is used to connect either the left eye image or the stack image.
– Right Input: The green input is used to connect the right eye image. This input is available only when the Stack Mode menu is set to Separate.

Outputs

Unlike most nodes in Fusion, Global Align has two outputs for the left and right eye.

– Left Output: This outputs the newly aligned left eye image.
– Right Output: This outputs the newly aligned right eye image.

Basic Node Setup

Global Align is typically placed at the beginning of the node tree. Below it is inserted between the left and right eye images and the Disparity node to visually correct major differences.

A Global Align node used to manually correct left and right eye discrepancies
Inspector

The Global Align Controls tab

Controls Tab
The Controls tab includes translation and rotation controls to align the stereo images manually.

Translation X and Y

- **Balance:** Determines how the global offset is applied to the stereo footage.
- **None:** No translation is applied.
- **Left Only:** The left eye is shifted, while the right eye remains unaltered.
- **Right Only:** The right eye is shifted, while the left eye remains unaltered.
- **Split Both:** Left and right eyes are shifted in opposite directions.

Snap to Nearest Pixel
While adjusting the X or Y shift dial, this option ensures that the image is shifted in full pixel amounts only to maintain optimum quality. This avoids sub-pixel rendering of the image, which could result in subtle blurring.

Rotation

- **Balance:** Determines how the global rotation is applied to the stereo footage.
- **None:** No rotation is applied.
- **Left Only:** The left eye is rotated, while the right eye remains unaltered.
- **Right Only:** The right eye is rotated, while the left eye remains unaltered.
- **Split Both:** Left and right eyes are rotated in opposite directions.

Angle
This dial adjusts the angle of the rotation. Keep in mind that the result depends on the Balance settings. If only rotating one eye by, for example, 10 degrees, a full 10-degree rotation will be applied to that eye.

When applying rotation in Split mode, one eye will receive a -5 degree and the other eye a +5 degree rotation.
Translation Filter Method
This menu chooses the filter method that delivers the best results depending on the content of your footage.

Visualization
This control allows for different color encodings of the left and right eye to conveniently examine the results of the above controls without needing to add an extra Anaglyph or Combiner node.
Set this to None for final output.

Stack Mode
Determines how the input images are stacked.
When set to Separate, the right input and output will appear, and separate left and right images must be connected.

Swap Eyes
With Stacked Mode, image stereo pairs’ left and right images can be swapped.

Common Controls
Settings Tab
The Settings tab in the Inspector is also duplicated in other Stereo nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

New Eye [NE]

The New Eye node

NOTE: The New Eye node is available only in Fusion Studio and DaVinci Resolve Studio.

New Eye Node Introduction
The New Eye node constructs a new image by interpolating between two existing stereo images using the embedded disparity channels. This node can also be used to replace one view with a warped version of the other. In Stack Mode, L and R outputs will output the same image.
You can map the left eye onto the right eye and replace it. This can be helpful when removing errors from certain areas of the frame.
New Eye does not interpolate the aux channels but instead destroys them. In particular, the disparity channels are consumed/destroyed. Add another Disparity node after the New Eye if you want to generate Disparity for the realigned footage.
**Inputs**
The two inputs on the New Eye node are used to connect the left and right images.

- **Left Input:** The orange input is used to connect either the left eye image or the stack image.
- **Right Input:** The green input is used to connect the right eye image. This input is available only when the Stack Mode menu is set to Separate.

**Outputs**
Unlike most nodes in Fusion, New Eye has two outputs for the left and right eye.

- **Left Output:** This outputs the left eye image with a new disparity channel, or a Stacked Mode image with a new disparity channel.
- **Right Output:** This outputs the right eye image with a new disparity channel. This output is visible only if Stack Mode is set to Separate.

**Basic Node Setup**
The New Eye node in the example below constructs a new image by interpolating between the two stereo images using the embedded disparity channels.

![Diagram of New Eye node setup](image)

A New Eye node creates a new stereo image using embedded disparity

**Inspector**

![Inspector for New Eye node](image)

The New Eye Controls tab
### Controls Tab

The Controls tab is divided into identical parameters for the left eye and right eye. The parameters are used to select which eye to recreate and the methods used for the interpolation.

#### Enable

The Enable checkbox allows you to activate the left or right eye independently. The New Eye will replace enabled eye with an interpolated eye. For example, if the left eye is your "master" eye and you are recreating the right eye, you would disable the left eye and enable the right eye.

#### Lock XY

Locks the X and Y interpolation parameters. When they are unlocked, you can provide separate interpolation factors for using the X and Y disparity. For example, if you are working with the right eye and you have the X Interpolation slider set to 1.0 and the Y Interpolation slider set to -1.0, you will be effectively interpolating the left eye onto the right eye but vertically aligned to the left eye.

#### XY Interpolation Factor

Interpolation determines where the interpolated frame is positioned, relative to the two source frames: A slider position of -1.0 outputs the frame Left and a slider position of 1.0 outputs the frame Right. A slider position of 0.0 outputs a result that is halfway between Left and Right.

#### Depth Ordering

The Depth Ordering is used to determine which parts of the image should be rendered on top. When warping images, there is often overlap. When the image overlaps itself, there are two options for which values should be drawn on top.

- **Largest Disparity On Top**: The larger disparity values will be drawn on top in the overlapping image sections.
- **Smallest Disparity On Top**: The smaller disparity values will be drawn on top in the overlapping image sections.

#### Clamp Edges

Under certain circumstances, this option can remove the transparent gaps that may appear on the edges of interpolated frames. Clamp Edges will cause a stretching artifact near the edges of the frame that is especially visible with objects moving through it or when the camera is moving.

Because of these artifacts, it is a good idea to use Clamp Edges only to correct small gaps around the edges of an interpolated frame.

#### Softness

Helps to reduce the stretchy artifacts that might be introduced by Clamp Edges.

If you have more than one of the Source Frame and Warp Direction checkboxes turned on, this can lead to doubling up of the stretching effect near the edges. In this case, you'll want to keep the softness rather small at around 0.01. If you have only one checkbox enabled, you can use a larger softness at around 0.03.

#### Source Frame and Warp Direction

The output of this node is generated by combining up to four different warps. You can choose to use either the color values from the left or right frame in combination with the Forward (left > right) Disparity or the Backward (right > left) Disparity. Sometimes you will want to replace an existing eye. For example, if you want to regenerate the right eye, you would only use left eye warps.

It’s good to experiment with various options to see which gives the best effect. Using both the left and right eyes can help fill in gaps on the left/right side of images. Using both the Forward/Backward Disparity can give a doubling-up effect in places where the disparities disagree with each other.
– **Left Forward**: Takes the Left frame and uses the Forward Disparity to interpolate the new frame.
– **Right Forward**: Takes the Right frame and uses the Forward Disparity to interpolate the new frame.
– **Left Backward**: Takes the Left frame and uses the Back Disparity to interpolate the new frame.
– **Right Backward**: Takes the Right frame and uses the Back Disparity to interpolate the new frame.

**Common Controls**

**Settings Tab**
The Settings tab in the Inspector is also duplicated in other Stereo nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

**Splitter [Spl]**

![The Splitter node](image)

**NOTE**: The Splitter node is available only in Fusion Studio and DaVinci Resolve Studio.

**Splitter Node Introduction**
The Splitter takes a stacked input image—for example, created with the Combiner—and provides two output images: a left eye and a right eye.

**Inputs**
The two inputs on the Splitter node are used to connect the left and right images.
– **Left Input**: The orange input is used to connect a stacked stereo image.

**Outputs**
Unlike most nodes in Fusion, the Splitter node has two outputs for the left and right eye.
– **Left Output**: This outputs the left eye image.
– **Right Output**: This outputs the right eye image.

**Basic Node Setup**
Below, a stacked stereo image is connected to the input on a Splitter where a left and right eye is output.
A Splitter node creates a left and right image from a stacked stereo image

**Inspector**

The Splitter Controls tab

**Controls Tab**

The Controls tab is used to define the type of stacked image connected to the node’s input.

**Split**

The Split menu contains three options for determining the orientation of the stacked input image.

- **None**: No operation takes place. The output image on both outputs is identical to the input image.
- **Horiz**: The node expects a horizontally stacked image. This will result in two output images, each being half the width of the input image.
- **Vert**: The node expects a vertically stacked image. This will result in two output images, each being half the height of the input image.

**Swap Eyes**

Allows you to easily swap the left and right eye outputs.

**Common Controls**

**Settings Tab**

The Settings tab in the Inspector is also duplicated in other Stereo nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

**Stereo Align [SA]**

The StereoAlign node

**NOTE**: The Stereo Align node is available only in Fusion Studio and DaVinci Resolve Studio.
Stereo Align Node Introduction

This extremely versatile node for fixing Stereo issues can be used for performing any of the following actions or combinations thereof:

– Vertical alignment of one eye to the other
– Changing the convergence
– Changing the eye separation

By combining these operations in one node, you can execute them using only a single image resampling. In essence, this node can be thought of as applying scales and translation to the disparities and then using the modified disparities to interpolate between the views.

**NOTE:** Changing the eye separation can cause holes to appear, and it may not be possible to fill them since the information needed may not be in either image. Even if the information is there, the disparity may have mismatched the holes. You may need to fill the holes manually. This node modifies only the RGBA channels.

**TIP:** Stereo Align does not interpolate the aux channels but instead destroys them. In particular, the disparity channels are consumed/destroyed. Add another Disparity node after the StereoAlign if you want to generate Disparity for the realigned footage.

Inputs

The two inputs on the Stereo Align node are used to connect the left and right images.

– **Left Input:** The orange input is used to connect either the left eye image or the stack image.
– **Right Input:** The green input is used to connect the right eye image. This input is available only when the Stack Mode menu is set to Separate.

Outputs

Unlike most nodes in Fusion, Stereo Align has two outputs for the left and right eye.

– **Left Output:** This outputs the left eye image with a new disparity channel, or a Stacked Mode image with a new disparity channel.
– **Right Output:** This outputs the right eye image with a new disparity channel. This output is visible only if Stack Mode is set to Separate.

Basic Node Setup

Below, the Stereo Align receives the left and right eye images with disparity. Once the adjustments are made, another Disparity node is added after it to generate disparity for the realigned footage.
A Stereo Align node destroys the disparity channel, so another Disparity node is placed after it.

**Inspector**

The Stereo Align Controls tab

**Controls Tab**

**Vertical Alignment**

This option determines how the vertical alignment is split between two eyes. Usually, the left eye is declared inviolate, and the right eye is aligned to it to avoid resampling artifacts.
When doing per pixel vertical alignment, it may be helpful to roughly pre-align the images by a global Y-shift before disparity computation because the disparity generation algorithm can have problems resolving small objects that move large distances.

Also, be aware that you must be careful about lens distortion because even if two cameras are perfectly vertically aligned, they will still have vertical disparities due to lens distortion. As a best practice, remove the lens distortion before computing the disparity. When a vertical alignment of the right eye is done, you have essentially removed the Y-component of the lens distortion in the right eye, and it will look wrong later when you try to distort it again.

**Apply to**
- **Right**: Only the right eye is adjusted.
- **Left**: Only the left eye is adjusted.
- **Both**: The vertical alignment is split evenly between the left and right eyes.

**Mode**
- **Global**: The eyes are simply translated up or down by the Y-shift to match up.
- **Per Pixel**: The eyes are warped pixel-by-pixel using the disparity to vertically align.

Keep in mind that this can introduce sampling artifacts and edge artifacts.

**Y-shift**
Y-shift is available only when the Mode menu is set to Global. You can either adjust the Y-shift manually to get a match or drag the Sample button into the viewer, which picks from the disparity channel of the left eye. Also remember, if you use this node to modify disparity, you can’t use the Sample button while viewing the node’s output.

**Snap to Whole Pixels**
You can snap the global shift to whole pixels by enabling this option. When enabled, there is no resampling of the image, but rather a simple shift is done so there will be no softening or image degradation.

**Convergence Point**
The Convergence Point section is used as a global X-translation of L/R images.

**Apply to**
This menu determines which eyes are affected by convergence. You can choose to apply the convergence to the left eye, right eye, or split between the two. In most cases, this will be set to Split. If you set the eyes to Split, then the convergence will be shared 50-50 between both eyes. Sharing the convergence between both eyes means you get half the shift in each eye, which in turn means smaller holes and artifacts that need to be fixed later. The tradeoff is that you’ve resampled both eyes rather than keeping one eye as a pure reference master.

**X-shift**
You can either use the slider to adjust the X-shift manually to get a match or use the Sample button to pick from the disparity channels for easy point-to-feature alignment.

**Snap**
You can snap the global shift to whole pixels using this option. In this mode, there is no resampling of the image, but rather a simple shift is done so there will be no softening or image degradation.
**Eye Separation**

Eye Separation changes the distance between the left/right eyes, causing objects in the left/right eyes to converge/diverge further depending on their distance from the camera. This has the same effect as the Eye Separation option in the Camera 3D node.

**Separation**

This is a scale factor for eye separation.

- When set to 0.0, this leaves the eyes unchanged.
- Setting it to 0.1 increases the shifts of all objects in the scene by a factor of 10% in each eye.
- Setting it to 0.1 will scale the shifts of all objects 10% smaller.

Unlike the Split option for vertical alignment, which splits the alignment effect 50-50 between both eyes, the Both option will apply 100-100 eye separation to both eyes. If you are changing eye separation, it can be a good idea to enable per-pixel vertical alignment, or the results of interpolating from both frames can double up.

**Left/Right Eye Options**

The left and right eye options contain depth ordering and warp direction controls independently for the left and right eye.

**Depth Ordering**

The Depth Ordering is used to determine which parts of the image should be rendered on top. When warping images, there is often overlap. When the image overlaps itself, there are two options for which values should be drawn on top.

- **Largest Disparity On Top**: The larger disparity values will be drawn on top in the overlapping image sections.
- **Smallest Disparity On Top**: The smaller disparity values will be drawn on top in the overlapping image sections.

**Clamp Edges**

Under certain circumstances, this option can remove the transparent gaps that may appear on the edges of interpolated frames. Clamp Edges will cause a stretching artifact near the edges of the frame that is especially visible with objects moving through it or when the camera is moving.

Because of these artifacts, it is a good idea to use Clamp Edges only to correct small gaps around the edges of an interpolated frame.

**Edge Softness**

Helps to reduce the stretchy artifacts that might be introduced by Clamp Edges.

If you have more than one of the Source Frame and Warp Direction checkboxes turned on, this can lead to doubling up of the stretching effect near the edges. In this case, you'll want to keep the softness rather small at around 0.01. If you have only one checkbox enabled, you can use a larger softness at around 0.03.

**Source Frame and Warp Direction**

The output of this node is generated by combining up to four different warps. You can choose to use either the color values from the left or right frame in combination with the Forward (left > right) Disparity or the Backward (right > left) Disparity. Sometimes you will want to replace an existing eye. For example, if you want to regenerate the right eye, you would use only left eye warps.
It's good to experiment with various options to see which gives the best effect. Using both the left and right eyes can help fill in gaps on the left/right side of images. Using both the Forward/Backward Disparity can give a doubling-up effect in places where the disparities disagree with each other.

- **Left Forward**: Takes the Left frame and uses the Forward Disparity to interpolate the new frame.
- **Right Forward**: Takes the Right frame and uses the Forward Disparity to interpolate the new frame.
- **Left Backward**: Takes the Left frame and uses the Back Disparity to interpolate the new frame.
- **Right Backward**: Takes the Right frame and uses the Back Disparity to interpolate the new frame.

**Stack Mode**

In Stack Mode, L and R outputs will output the same image.

If High Quality is off, the interpolations are done using nearest-neighbor sampling, leading to a more "noisy" result. To ensure High Quality is enabled, right-click under the viewers, near the transport controls, and choose High Quality from the pop-up menu.

**Swap Eyes**

 Allows you to easily swap the left and right eye outputs.

**Common Controls**

**Settings Tab**

The Settings tab in the Inspector is also duplicated in other Stereo nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

**Example**

Different settings for Eye Separation...

...and example settings for Convergence
Z To Disparity [Z2D]

The Z To Disparity node

NOTE: The Z To Disparity node is available only in Fusion Studio and DaVinci Resolve Studio.

Z To Disparity Node Introduction

Z To Disparity takes a stereo camera and an image containing a Z channel and outputs the same image but with disparity channels in it. This is useful for constructing a Disparity map from CG renders, which will be more accurate than the Disparity map created from the Disparity node.

Inputs

The three inputs on the Z To Disparity node are used to connect the left and right images and a camera node.

- **Left Input**: The orange input is used to connect either the left eye image or the stack image.
- **Right Input**: The green input is used to connect the right eye image. This input is available only when the Stack Mode menu is set to Separate.
- **Stereo Camera**: The magenta input is used to connect a stereo perspective camera, which may be either a Camera 3D with eye separation, or a tracked L/R Camera 3D.

Outputs

Unlike most nodes in Fusion, Z To Disparity has two outputs for the left and right eye.

- **Left Output**: This outputs the left eye image containing a new disparity channel, or a Stacked Mode image with a new disparity channel.
- **Right Output**: This outputs the right eye image with a new disparity channel. This output is visible only if Stack Mode is set to Separate.

Basic Node Setup

Below, a stereo camera and an image containing a Z channel is connected to a Z To Disparity node. The same image is output with disparity channels.

A Z To Disparity node takes an image with a Z channel and creates a disparity channel
Inspector

The Z To Disparity Controls tab

**Controls Tab**
The Controls tab includes settings that refine the conversion algorithm.

**Output Disparity To RGB**
In addition to outputting disparity values into the disparity channel, activating this checkbox causes Z To Disparity to also output the disparity values into the color channels as \((x, y, 0, 1)\).

When activated, this option will automatically promote the RGBA color channels to float32. This option is useful for a quick look to see what the disparity channel looks like.

**Refine Disparity**
This refines the Disparity map based on the RGB channels.

**Strength**
Increasing this slider does two things. It smooths out the depth in constant color regions and moves edges in the Z channel to correlate with edges in the RGB channels. Increasing the refinement has the undesirable effect of causing texture in the color channel to show up in the Z channel. You will want to find a balance between the two.

**Radius**
This is the pixel-radius of the smoothing algorithm.

**Stack Mode**
In Stack Mode, L and R outputs will output the same image.

If HiQ is off, the interpolations are done using nearest-neighbor sampling, leading to a more “noisy” result.

**Swap Eyes**
This allows you to easily swap the left and right eye outputs.

The Z To Disparity Camera tab
Camera Tab

The Camera tab includes settings for selecting a camera and setting its conversion point if necessary.

Camera Mode

If you need correct real-world disparity values because you are trying to match some effect to an existing scene, you should use the External setting to get precise disparity values back. When External is selected, a magenta camera input is available on the node to connect an existing stereo Camera 3D node, and use the Camera settings to determine the Disparity settings.

If you just want any disparity and do not particularly care about the exact details of how it is offset and scaled, or if there is no camera available, then the Artistic setting might be helpful.

Camera

If you connect a Merge 3D node that contains multiple cameras to the camera input, the Camera menu allows you to select the camera to use.

Artistic Camera mode

If you do not have a camera, you can adjust the artistic controls to produce a custom disparity channel whose values will not be physically correct but will be good enough for compositing hacks. There are two controls to adjust:

Convergence Point

This is the Z value of the convergence plane. This corresponds to the negative of the Convergence Distance control that appears in Camera 3D. At this distance, objects in the left and right eyes are at exactly the same position (i.e., have zero disparity).

_objects that are closer appear to pop out of the screen, and objects that are further appear behind the screen.

Background Disparity (Sample from Left Eye)

This is the disparity of objects in the distant background. You can think of this as the upper limit to disparity values for objects at infinity. This value should be for the left eye. The corresponding value in the right eye will be the same in magnitude but negative.

Settings Tab

The Settings tab in the Inspector is also duplicated in other Stereo nodes. These common controls are described in detail in the following “The Common Controls” section.
The Common Controls

The Common Settings tab can be found on virtually every tool found in Fusion. The following controls are specific settings for Stereo nodes.

Settings Tab

The Common Settings Stereo 3D Settings tab

Blend

The Blend control is used to blend between the tool's original image input and the tool's final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming image. Normally, this will cause the tool to skip processing entirely, copying the input straight to the output.

Process When Blend Is 0.0

The tool is processed even when the input value is zero. This can be useful if the node is scripted to trigger a task, but the node's value is set to 0.0.

Red/Green/Blue/Alpha Channel Selector

These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.

For example, if the Red button on a Blur tool is deselected, the blur will first be applied to the image, and then the red channel from the original input will be copied back over the red channel of the result.

There are some exceptions, such as tools for which deselecting these channels causes the tool to skip processing that channel entirely. Tools that do this will generally possess a set of identical RGBA buttons on the Controls tab in the tool. In this case, the buttons in the Settings and the Controls tabs are identical.
**Apply Mask Inverted**

Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

**Multiply by Mask**

Selecting this option will cause the RGB values of the masked image to be multiplied by the mask channel's values. This will cause all pixels of the image not included in the mask (i.e., set to 0) to become black/transparent.

**Use Object/Use Material (Checkboxes)**

Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports Object ID and Material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels will be used, if present. The specific Material ID or Object ID affected is chosen using the next set of controls.

**Correct Edges**

This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option is disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information on Coverage and Background Color channels, see Chapter 18, “Understanding Image Channels” in the Fusion Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.

**Object ID/Material ID (Sliders)**

Use these sliders to select which ID will be used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker: to grab IDs from the image displayed in the viewer. The image or sequence must have been rendered from a 3D software package with those channels included.

**Hide Incoming Connections**

Enabling this checkbox can hide connection lines from incoming nodes, making a node tree appear cleaner and easier to read. When enabled, empty fields for each input on a node will be displayed in the Inspector. Dragging a connected node from the node tree into the field will hide that incoming connection line as long as the node is not selected in the node tree. When the node is selected in the node tree, the line will reappear.

**Comments**

The Comments field is used to add notes to a tool. Click in the empty field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

**Scripts**

Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
Chapter 118

Tracker Nodes

This chapter details the Tracker nodes available in Fusion.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

- Tracker [Tra] 2342
- Planar Tracker Node [PTra] 2356
- Planar Transform Node [PXF] 2366
- Camera Tracker [CTra] 2368
- The Common Controls 2383
Tracker [Tra]

The Tracker node

Tracker Node Introduction

The Tracker is used to detect and follow one or more pixel patterns across frames in moving video. The tracking data can then be used to control the position or values of other nodes in the composition (for example, the center of a Light Rays node). Additionally, trackers can be used to stabilize an image or to apply destabilization to one image based on the motion of another.


Inputs

The Tracker has three inputs:

- **Background**: The orange image input accepts the main 2D image to be tracked.
- **Foreground**: The optional green foreground accepts a 2D image to be merged on top of the background as a corner pin or match move.
- **Effect Mask**: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the tracking to certain areas.

Basic Node Setup

Tracker nodes can be applied inline with other nodes or as a branch from the clip you want to track. When used inline, an image can be stabilized by connecting it to the orange background input. After the image is tracked, setting the Tracker’s Operation menu to Match Move will apply a stabilization to the connected image.

When used as an offshoot from the node tree, an image can be tracked and then that tracking data is published for use on another node somewhere else in the node tree. The output of the Tracker does not need to connect to another node. The tracking data is published and can be used via the Connect To contextual menu.
A Tracker node branched from the node tree

The Tracker can also work as a replacement for a Merge tool in match-moving setups. Below, the Tracker tracks the image connected to the orange background input and applies the tracking data to the image connected to the foreground input. The same foreground-over-background merge capabilities are available in the Tracker node.

Tracker Onscreen Controls

Each pattern in the Tracker has its own set of onscreen controls used to select the pixels in the image to be tracked. These controls are visible in the viewers whenever you select a tracker in the node tree.

Pattern Rectangle

In the viewer, the tracker displays a solid-line red rectangle called the pattern rectangle. Every pixel within the rectangle makes up the pattern used for tracking. You can resize the pattern if necessary by dragging on the rectangle's borders.
**Search Rectangle**

Whenever the mouse moves over the pattern rectangle, a second rectangle with a dashed outline appears. The dashed outline represents the search area, which determines how far away from the current pattern the Tracker looks in the next frame. The search area should always be larger than the pattern, and it should be large enough to encompass the largest frame-to-frame movement in the scene. Faster moving objects require larger search areas, and slower moving objects can get away with smaller search areas. The larger the search area, the longer it takes to track, so try not to make the search area larger than necessary. If the selected Tracker has a custom name, the name of that Tracker is displayed as a label at the bottom right of the search area rectangle.

![Image of search rectangle with coordinates](image)

The search rectangle is the area searched from frame to frame to locate the pattern.

**Repositioning the Tracker**

The pattern rectangle has a small handle in the upper-left corner. Dragging on the handle repositions the pattern. An enlarged view of the pattern is displayed under your mouse pointer to assist with the precise positioning of the pattern. This thumbnail disappears when the mouse button is released. You can adjust the magnification ratio in the Inspector’s Options tab.

![Image of pattern rectangle with handle](image)

Dragging the handle magnifies the pattern rectangle for precise placement.

---

**TIP:** There is no limit to the number of trackers that can be used in one composition, or the number of objects that use the tracking data. There is also no limit to the number of patterns that can be tracked by a single Tracker node. This chapter serves as a reference for the various controls in the Tracker, but we strongly suggest you read the more general information in Chapter 22, “Using the Tracking Node” in the Fusion Reference Manual or Chapter 83 in the DaVinci Resolve Reference Manual.

The Tracker can be employed in two forms: as a node in the Node Editor or as a modifier attached to a parameter. When used as a node in the Node Editor, the image tracked comes from the input to the Tracker node. When used as a modifier, controls appear in the Modifiers tab for the node with the connected control. Tracker Modifiers can track only one pattern, but the image source can come from anywhere in the composition. Use this technique when tracking a quick position for an element.
The Tracker node 

The Trackers tab contains controls for creating, positioning, and initiating tracking operations. After tracking, offset controls are used to improve the alignment of the image following the track.

Track Buttons

There are four buttons to initiate tracking, and one button in the middle used to stop a track in progress. These buttons can track the current pattern forward or backward in time. Holding the pointer over each button displays a tooltip with the name of each button.

The buttons operate as follows:

- **Track Reverse**: Clicking this button causes all active trackers to begin tracking, starting at the end of the render range and moving backward through time until the beginning of the render range.

- **Track Reverse From Current Time**: Clicking this button causes all active trackers to begin tracking, starting at the current frame and moving backward through time until the beginning of the render range.

- **Stop Tracking**: Clicking this button or pressing ESC stops the tracking process immediately. This button is active only when tracking is in process.

- **Track Forward From Current Time**: Clicking this button causes all active trackers to begin tracking, starting at the current frame and moving forward through time until the end of the render range.

- **Track Forward**: Clicking this button causes all active trackers to begin tracking, starting at the first frame in the render range and moving forward through time until the end of the render range.
**Tracking Behavior Controls**

The following controls all affect how trackers adapt to changing patterns, how the resulting track path is defined, and how many keyframes are generated.

**Frames Per Path Point**

This slider determines how often the Tracker sets a keyframe on the path. The default is 1, which sets a keyframe on the tracked path at every frame.

Increasing the value causes the tracked path to be less accurate. This may be desirable if the track is returning fluctuating results, but under normal circumstances, leave this control at its default value.

*TIP:* If the project is field rendered, a value of 1 sets a keyframe on every field. Since the Tracker is extremely accurate, this will result in a slight up-and-down jittering due to the position of the fields. For better results when tracking interlaced footage in Field mode, set the Frames Per Path Point slider to a value of 2, which results in one keyframe per frame of your footage.

**Adaptive Mode**

Fusion is capable of reacquiring the tracked pattern, as needed, to help with complex tracks. This menu determines the Adaptive tracking method.

- **None:** When set to None, the tracker searches for the original pattern in each frame.
- **Every Frame:** When set to Every Frame, the tracker reacquires the pattern every frame. This helps the Tracker compensate for gradual changes in profile and lighting over time.
- **Best Match:** When set to Best Match, the tracker compares the original selected pattern to the pattern acquired at each frame. If the variation between the two patterns exceeds the threshold amount defined by the Match Tolerance control, the tracker does not reacquire the pattern on that frame. This helps to avoid Tracker drift caused by transient artifacts that cross the pattern’s path (such as a shadow).

**Path Center**

This menu determines how the Tracker behaves when repositioning a pattern. This menu is particularly useful when a pattern leaves the frame or changes so significantly that it can no longer be tracked.

- **Pattern Center:** When Pattern Center is selected in the menu, the tracked path continues from the center of the new path. This is appropriate when replacing an existing path entirely.
- **Track Center (append):** When Track Center (append) is selected in the menu, the path tracked by a new pattern will be appended to the existing path. The path created is automatically offset by the required amount. This setting is used to set a new tracking pattern when the original pattern moves out of the frame or gets obscured by other objects. This technique work bests if the new pattern is located close to the position of the original pattern to avoid any problems with parallax or lens distortion.

**Tracker List**

A Tracker node can track multiple patterns. Each tracker pattern created in the current Tracker node is managed in the Tracker List.

**Tracker List**

The Tracker List shows the names of all trackers created.

- Each tracker pattern appears in the list by name, next to a small checkbox. Clicking the name of the tracker pattern will select that tracker pattern.
– The controls below the list will change to affect that tracker pattern only. Click a selected tracker pattern once to rename the tracker pattern to something more descriptive.
– Clicking the checkbox changes the state of the tracker.

**Tracker States**

– **Enabled (black checkbox):** An enabled pattern will re-track each time the track is initiated. Its path data is available for use by other nodes, and the data is available for Stabilization and Corner Positioning.
– **Suspended (white circle):** A Suspended pattern does not re-track when the track is initiated. The data is locked to prevent additional changes. The data from the path is still available for other nodes, and the data is available for advanced Tracking modes like Stabilization and Corner Positioning.
– **Disabled (clear):** A Disabled pattern does not create a path when tracking is initialized, and its data is not available to other nodes or for advanced Tracking operations like Stabilization and Corner Positioning.

**Add/Delete Tracker**

Use these buttons to add or delete trackers from your Tracker List.

**Show**

This menu selects what controls are displayed in the Tracker node controls. They do not affect the operation of the tracker, they only affect the lower half of the Inspector interface.

– **Selected Tracker Details:** When Selected Tracker Details is chosen, the controls displayed pertain only to the currently selected tracker. You will have access to the Pattern window and the Offset sliders.
– **All Trackers:** When All Trackers is selected, the pattern window for each of the added tracking patterns is displayed simultaneously below the Tracker List.

**Left Pattern Display**

The pattern display has two side-by-side image windows and a series of status bars. The window on the left shows the pattern initially selected, while the one on the right shows a real-time display of the current pattern as tracking progresses.

As the onscreen controls move while tracking, the display in the leftmost window updates to show the pattern. As the pattern moves, the vertical bars immediately to the right of the image indicate the clarity and contrast of the image channels.

The best channel or channels get selected for tracking based on clarity. These channels have a gray background in the vertical bar representing that channel. You can use the automatic tracking or override the selection and choose the channel by selecting the button beneath the channel to track.
Under normal circumstances, the channel selected shows in the pattern display. If the selected channel is blue, then a grayscale representation of the blue channel for the pattern appears. The image is represented in color only when you activate the Full Color button.

Override this behavior by selecting the Show Full Color button beneath the pattern display instead of the Show Selected Channel button.

**TIP:** Because Fusion looks for the channel with the highest contrast automatically, you might end up tracking a noisy but high-contrast channel. Before tracking, it's always a good idea to zoom in to your footage and check the RGB channels individually.

**Right Pattern Display**

The pattern display on the right indicates the actual pattern acquired for tracking. This display is black until tracking the selected pattern for the first time. The pattern display becomes active during tracking, displaying the pattern that Fusion acquires from frame to frame.

As the tracking occurs, the pattern from each frame accumulates into a Flipbook, which can be played back in the pattern window after tracking by using the transport controls at the bottom of the window.

While the track is progressing, the vertical bar immediately to the right of the pattern shows how confident Fusion is that the current pattern matches the initially selected pattern. A green bar indicates a high degree of confidence that the current pattern matches the original, a yellow bar indicates less certainty, and a red bar indicates extreme uncertainty.

After tracking, the pattern display shows a small Flipbook of the track for that pattern to help identify problem frames for the track.

**Tracker Sizes**

In addition to onscreen controls, each tracker has a set of sizing parameters that let you adjust the pattern and search box.

- **Pattern Width and Height:** Use these controls to adjust the width and height of the selected tracker pattern manually. The size of the tracker pattern can also be adjusted in the viewer, which is the normal method, but small adjustments are often easier to accomplish with the precision of manual controls.

- **Search Width and Height:** The search area defines how far Fusion will look in the image from frame to frame to reacquire the pattern during tracking. As with the Pattern Width and Height, the search area can be adjusted in the viewer, but you may want to make small adjustments manually using these controls.

**Tracked Center**

This positional control indicates the position of the tracker’s center. To remove a previously tracked path from a tracker pattern, right-click this parameter and select Remove Path from the contextual menu.
**X and Y Offset**

The Offset controls help to create a track for objects that may not provide very well defined or reliable patterns. The Offset controls permit the tracking of something close to the intended object instead. Use these Offsets to adjust the desired position of the path, while the tracker pattern rectangle is positioned over the actual tracking location.

The Offset can also be adjusted directly in the viewer by activating the Offsets button in the viewer toolbar.

![The tracker offset icon in the upper left of the viewer is used to offset the tracking pattern from the intended object.](image)

**Operation Tab**

While the Trackers tab controls let you customize how the Tracker node analyzes motion to create motion paths, the Operation tab puts the analyzed motion data to use, performing image transforms of various kinds.

The Tracker node is capable of performing a wide variety of functions, from match moving an object into a moving scene, smoothing out a shaky camera movement, or replacing the content of a sign. Use the options and buttons in the Operation tab to select the function performed by the Tracker node.

**Operation Menu**

The Operation menu contains four functions performed by the Tracker. The remaining controls in this tab fine-tune the result of this selection.

- **None**: The Tracker performs no additional operation on the image beyond merely locating and tracking the chosen pattern. This is the default mode, used to create a path that will then drive another parameter on another node.
– **Match Move:** When only the orange background input is connected, this mode stabilizes the image. When a foreground image is connected to the green foreground input, the foreground image matches the position, rotation, and scaling based on the tracking patterns. Stabilizing and match move require a minimum of one tracking pattern to determine position, and two or more to determine scaling and rotation.

– **Corner Positioning:** The Corner Positioner mode tracks the four corners of a rectangular object and replaces the contents with a new image. This function requires a minimum of four tracking patterns. If there are not enough tracking patterns, new tracking patterns are added until the total equals four.

– **Perspective Positioning:** This mode is the inverse of the Corner Positioning mode. Rather than replacing the contents of the rectangle, the four trackers are mapped to the four corners of the image. This is generally used to remove perspective from an image. Like the Corner Positioning mode, this mode requires four tracking patterns, which automatically get added if there are fewer patterns.

### Additional Layering Controls

When you choose any operation other than None, a series of additional controls appear.

#### Merge

The Merge control determines what is done (if anything) with the image provided to the green Foreground input of the Tracker. This menu appears when the operation is set to anything other than None.

– **BG Only:** The foreground input is ignored; only the background is affected. This is used primarily when stabilizing the background image.

– **FG Only:** The foreground input is transformed to match the movement in the background, and this transformed image is passed through the Tracker’s output. This Merge technique is used when match moving one layer’s motion to another layer’s motion.

– **FG Over BG:** The foreground image is merged over the background image, using the Merge method described by the Apply Mode control that appears.

– **BG Over FG:** The background is merged over the foreground. This technique is often used when tracking a layer with an Alpha channel so that a more static background can be applied behind it.

#### Apply Mode and Operator Menus

This menu provides a variety of options that determine how the two layers should be combined. The options in this menu are identical to those found in the Merge node.

– **Apply Modes:** The Apply Mode setting determines the math used when blending or combining the foreground and background pixels.

  – **Normal:** The Default merge mode uses the foreground’s alpha channel as a mask to determine which pixels are transparent and which are not. When this is active, another menu shows possible operations, including Over, In, Held Out, Atop, and XOR.

  – **Screen:** Screen merges the images based on a multiplication of their color values. The alpha channel is ignored, and layer order becomes irrelevant. The resulting color is always lighter. Screening with black leaves the color unchanged, whereas screening with white will always produce white. This effect creates a similar look to projecting several film frames onto the same surface. When this is active, another menu shows possible operations, including Over, In, Held Out, Atop, and XOR.

  – **Dissolve:** Dissolve mixes two image sequences together. It uses a calculated average of the two images to perform the mixture.
- **Multiply:** Multiplies the values of a color channel. This will give the appearance of darkening the image as the values are scaled from 0 to 1. White has a value of 1, so the result would be the same. Gray has a value of 0.5, so the result would be a darker image or, in other words, an image half as bright.

- **Overlay:** Overlay multiplies or screens the color values of the foreground image, depending on the color values of the background image. Patterns or colors overlay the existing pixels while preserving the highlights and shadows of the color values of the background image. The background image is not replaced but is mixed with the foreground image to reflect the original lightness or darkness of the background image.

- **Soft Light:** Soft Light darkens or lightens the foreground image, depending on the color values of the background image. The effect is similar to shining a diffused spotlight on the image.

- **Hard Light:** Hard Light multiplies or screens the color values of the foreground image, depending on the color values of the background image. The effect is similar to shining a harsh spotlight on the image.

- **Color Dodge:** Color Dodge uses the foreground’s color values to brighten the background image. This is similar to the photographic practice of dodging by reducing the exposure of an area of a print.

- **Color Burn:** Color Burn uses the foreground’s color values to darken the background image. This is similar to the photographic practice of burning by increasing the exposure of an area of a print.

- **Darken:** Darken looks at the color information in each channel and selects the background or foreground image’s color value, whichever is darker, as the result color. Pixels lighter than the merged colors are replaced, and pixels darker than the merged color do not change.

- **Lighten:** Lighten looks at the color information in each channel and selects the background or foreground image’s color values, whichever is lighter, as the result color value. Pixels darker than the merged color are replaced, and pixels lighter than the merged color do not change.

- **Difference:** Difference looks at the color information in each channel and subtracts the foreground color values from the background color values or the background from the foreground, depending on which has the greater brightness value. Merging with white inverts the color. Merging with black produces no change.

- **Exclusion:** Exclusion creates an effect similar to but lower in contrast than the Difference mode. Merging with white inverts the base color values. Merging with black produces no change.

- **Hue:** Hue creates a result color with the luminance and saturation of the background color values and the hue of the foreground color values.

- **Saturation:** Saturation creates a result color with the luminance and hue of the base color and the saturation of the blend color.

- **Color:** Color creates a result color with the luminance of the background color value and the hue and saturation of the foreground. This preserves the gray levels in the image and is useful for coloring monochrome images.

- **Luminosity:** Luminosity creates a color with the hue and saturation of the background color and the luminance of the foreground color. This mode creates an inverse effect from that of the Color mode.

- **Operator Modes:** This menu is used to select the Operation Mode of the merge. It determines how the foreground and background are combined to produce a result. This drop-down menu is visible only when the Merge node’s Apply Mode is set to either Normal or Screen.

**NOTE:** For an excellent description of the math underlying the Operation modes, read “Compositing Digital Images,” Porter, T., and T. Duff, SIGGRAPH 84 proceedings, pages 253-259. Essentially, the math is as described below.
TIP: Some modes not listed in the Operator drop-down menu (Under, In, Held In, Below) are easily obtained by swapping the foreground and background inputs and choosing a corresponding mode.

The formula used to combine pixels in the merge is always $fg \cdot x + bg \cdot y$. The different operations determine exactly what $x$ and $y$ are, as shown in the description for each mode.

The Operator modes are as follows:

- **Over:** The Over mode adds the foreground layer to the background layer by replacing the pixels in the background with the pixels from the Z wherever the foreground’s alpha channel is greater than 1.
  
  $x = 1, \ y = 1-[\text{foreground Alpha}]$

- **In:** The In mode multiplies the alpha channel of the background input against the pixels in the foreground. The color channels of the foreground input are ignored. Only pixels from the foreground are seen in the final output. This essentially clips the foreground using the mask from the background.
  
  $x = [\text{background Alpha}], \ y = 0$

- **Held Out:** Held Out is essentially the opposite of the In operation. The pixels in the foreground image are multiplied against the inverted alpha channel of the background image. You can accomplish exactly the same result using the In operation and a Matte Control node to invert the matte channel of the background image.
  
  $x = 1-[\text{background Alpha}], \ y = 0$

- **ATop:** ATop places the foreground over the background only where the background has a matte.
  
  $x = [\text{background Alpha}], \ y = 1-[\text{foreground Alpha}]$

- **XOr:** XOr combines the foreground with the background wherever either the foreground or the background have a matte, but never where both have a matte.
  
  $x = 1-[\text{background Alpha}], \ y = 1-[\text{foreground Alpha}]$

- **Subtractive/Additive:** This slider controls whether Fusion performs an Additive merge, a Subtractive merge, or a blend of both. This slider defaults to Additive merging for most operations, assuming the input images are premultiplied (which is usually the case). If you don’t understand the difference between Additive and Subtractive merging, here’s a quick explanation:
  
  - An Additive merge is necessary when the foreground image is premultiplied, meaning that the pixels in the color channels have been multiplied by the pixels in the alpha channel. The result is that transparent pixels are always black since any number multiplied by 0 always equals 0. This obscures the background (by multiplying with the inverse of the foreground alpha), and then simply adds the pixels from the foreground.
  
  - A Subtractive merge is necessary if the foreground image is not premultiplied. The compositing method is similar to an Additive merge, but the foreground image is first multiplied by its alpha to eliminate any background pixels outside the alpha area.

In most software applications, you will find the Additive/Subtractive option displayed as a simple checkbox. Fusion lets you blend between the Additive and Subtractive versions of the merge operation, which is occasionally useful for dealing with problem composites with edges that are calling attention to themselves as too bright or too dark.

For example, using a Subtractive setting on a premultiplied image may result in darker edges. Using an Additive setting with a non-premultiplied image may result in lightening the edges.
By blending between Additive and Subtractive, you can tweak the edge brightness to be just right for your situation.

**Filter Method (Match Move)**

Determines which filter to use to handle image transforms made using the Tracker node. This menu appears only when the Operation Mode is set to Match Move.

- **Box**: This is a simple interpolation resize of the image.
- **Linear**: This uses a simplistic filter, which produces relatively clean and fast results.
- **Quadratic**: This filter produces a nominal result. It offers a good compromise between speed and quality.
- **Cubic**: This produces better results with continuous-tone images but is slower than Bi-Cubic. If the images have fine detail in them, the results may be blurrier than desired.
- **Catmull-Rom**: This produces good results with continuous-tone images that are resized down. It produces sharp results with finely detailed images.
- **Gaussian**: This is very similar in speed and quality to Bi-Cubic.
- **Mitchell**: This is similar to Catmull-Rom but produces better results with finely detailed images. It is slower than Catmull-Rom.
- **Lanczos**: This is very similar to Mitchell and Catmull-Rom but is a little cleaner and also slower.
- **Sinc**: This is an advanced filter that produces very sharp, detailed results; however, it may produce visible “ringing” in some situations.
- **Bessel**: This is similar to the Sinc filter but may be slightly faster.

**Edges**

This menu selects how the revealed edges are handled when the image is moved to match position and scaling.

- **Black Edges**: Out-of-frame edges revealed by Stabilization are left black.
- **Wrap**: Portions of the image moved off frame to one side are used to fill edges that are revealed on the opposite side.
- **Duplicate**: The last valid pixel on an edge is repeated to the edge of the frame.
- **Mirror**: Image pixels are mirrored to fill to the edge of the frame.

**Position, Rotation, and Scaling Checkboxes (Match Move)**

The Position, Rotation, and Scaling checkboxes appear only when the mode is set to Match Move. They determine what components of motion that Stabilization will attempt to correct in the image. For example, if only the Position checkbox is selected, no attempt will be made to correct for Rotation and Scaling in the image.

**Flatten Transformation (Match Move)**

This checkbox appears only when the mode is set to Match Move. Like most transformations in Fusion, Stabilization is concatenated with other sequential transformations by default. Selecting this checkbox will flatten the transform, breaking any concatenation taking place and applying the transform immediately.

**Mapping Type**

The Mapping Type control appears only in the Corner Positioning mode. There are two options in the menu:

- **Bi-Linear**: The first method is Bi-Linear, where the foreground image is mapped into the background without any attempt to correct for perspective distortion. This is identical to how previous versions of Fusion operated.
– **Perspective:** The foreground image is mapped into the background taking perspective distortion into account. This is the preferred setting since it maps better to the real world than the older Bi-Linear setting.

**Corner Selector (Corner or Perspective Positioning)**

When the operation of the Tracker is set to either Corner or Perspective Positioning modes, four drop-down menus appear. These options choose which trackers map to each of the four corners of the rectangle. This is useful when a Tracker has more than four patterns selected, and you must choose which patterns the positioners use.

**Rotate Clockwise and Counter-Clockwise Buttons (Corner or Perspective Positioning)**

These controls appear only when the operation of the Tracker is set to either Corner or Perspective Positioning modes. They are used to rotate the foreground image by 90 degrees before it is applied to the background.

**Stabilize Settings**

The Tracker node automatically outputs several steady and unsteady position outputs to which other controls in the Node Editor can be connected. The Stable Position output provides X and Y coordinates to match or reverse motion in a sequence. These controls are available even when the operation is not set to Match Move, since the Stable Position output is always available for connection to other nodes.

**Match Move Settings**

These settings determine how tracking data is correlated with the reference pattern for making transforms.

**Pivot Type**

The Pivot type menu determines how the anchor point for rotation is selected.

– **Tracker Average:** Averages the location based on the tracking points.

– **Selected Tracker:** Provides a menu where one of the current trackers can be selected as the pivot point.

– **Manual:** Displays X and Y position number fields where you can manually position the pivot points.

**Reference**

The Reference mode determines the “snapshot frame” based on the frame where the pattern is first selected. All Stabilization is intended to return the image back to that reference.

– **Select Time:** Lets you select the current frame.

– **Start:** The Snapshot Frame is determined to be the first frame in the tracked path. All Stabilization is intended to return the image back to that reference.

– **Start and End:** The Start and End Reference mode is somewhat different from all other Reference modes. Where the others are intended to take a snapshot frame to which all stabilization returns, immobilizing the image, the Start and End mode is intended to smooth existing motion, without removing it. This mode averages the motion between the Start and End of the path, drawing a straight line between those points.

  When this mode is active, it reveals the Reference Intermediate Points control. Increasing the value of this control increases the number of points in the path used by the Reference, smoothing the motion from a straight line between Start and End without making it wholly linear.

– **End:** The Snapshot Frame is determined to be the last frame in the tracked path. All Stabilization is intended to return the image back to that reference.
By default, the Tracker displays a single displacement path of the tracked data in the Spline Editor. To view X and Y paths of the tracked points in the Spline Editor, go to Preferences > Globals > Splines.

Display Options Tab
The Display Options tab lets you customize the look of onscreen controls in the viewer.

The Tracker Display Options tab

Show Pattern Names
This option defines whether the Tracker’s pattern names will be displayed in the viewer. Switch it off to see the pattern rectangle instead.

Enlarged Pattern on Dragging
This option defines whether there is a magnified thumbnail view when positioning the pattern rectangle.

Enlargement Scale
The zoom factor that is used when positioning the pattern rectangle when the above option is activated.

The outputs of a tracker (seen in the Connect to... menu) can also be used by scripts. They are:

- **SteadyPosition**: Steady Position
- **UnsteadyPosition**: Unsteady Position
- **SteadyAxis**: Steady Axis
- **SteadySize**: Steady Size
- **UnsteadySize**: Unsteady Size
- **SteadyAngle**: Steady Angle
- **UnsteadyAngle**: Unsteady Angle
- **Position1**: Tracker 1 Offset position
- **PerspectivePosition1**: Tracker 1 Perspective Offset position
- **PositionX1**: Tracker 1 Offset X position (3D Space)
- **PositionY1**: Tracker 1 Offset Y position (3D Space)
- **PerspectivePositionX1**: Tracker 1 Perspective Offset X position (3D Space)
- **PerspectivePositionY1**: Tracker 1 Perspective Offset Y position (3D Space)
- **SteadyPosition1**: Tracker 1 Steady Position
- **UnsteadyPosition1**: Tracker 1 Unsteady Position (likewise for the 2nd, 3rd, and so on)
Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other Tracking nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Planar Tracker Node [PTra]

Planar Tracker Node Introduction
The Planar Tracker node is designed to solve a match-moving problem that commonly comes up during post-production. As an example, live-action footage can often contain a planar surface such as a license plate or a road sign that needs new numbers in the license plate or a new city’s name on the road sign. Often, the problem is that the camera is moving in the shot, so the license plate or road sign is continuously changing perspective. You cannot just merge a new license plate over the existing one without accounting for the perspective distortions. A time-intensive way to solve this problem would be to use a Corner Pin node and manually keyframe the four corners. The Planar Tracker automates this keyframing process and tracks the perspective distortions of a planar surface over time. That tracking data is then applied with those same perspective distortions to a different foreground.

For more information on using the Planar Tracker, see Chapter 23, “Planar Tracking” in the Fusion Reference Manual or Chapter 84 in the DaVinci Resolve Reference Manual.

TIP: Part of using a Planar Tracker is also knowing when to give up and fall back to using Fusion’s Tracker node or to manual keyframing. Some shots are simply not trackable, or the resulting track suffers from too much jitter or drift. The Planar Tracker is a useful time-saving node in the artist’s toolbox, but while it may track most shots, it is not a 100% solution.

What the Planar Tracker Saves

While the Planar Tracker does save the resulting final track in the composition on disk, it does not save temporary tracking information such as the individual point trackers (compared with the Camera Tracker, which does save the individual point trackers). Some consequences of this include:

- The point trackers no longer appear in the viewer when a comp containing a Planar Tracker node is saved and reloaded.
- Tracking may not be resumed after a comp containing a Planar Tracker node has been saved and reloaded. In particular, this also applies to auto saves. For this reason, it is good to complete all planar tracking within one session.
- The size of composition files is kept reasonable (in some situations, a Planar Tracker can produce hundreds of megabytes of temporary tracking data).
- Saving and loading of compositions is faster and more interactive.
**Inputs**

The Planar Tracker has four inputs:

- **Background:** The orange background image input accepts a 2D image with the planar surface to be tracked.
- **Corner Pin 1:** The green corner pin 1 input accepts a 2D image to be pinned on top of the background. There may be multiple corner pin inputs, named Corner Pin 1, Corner Pin 2,...etc.
- **Occlusion Mask:** The white occlusion mask input is used to mask out regions that do not need to be tracked. Regions where this mask is white will not be tracked. For example, a person moving in front of and occluding bits of the pattern may be confusing the tracker, and a quickly-created rough rotomask around the person can be used to tell the tracker to ignore the masked-out bits.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the output of the Planar Tracker to certain areas.

**Basic Node Setup**

A basic Planar Tracker setup consists of just two nodes: a MediaIn connects to the background input and the Planar Tracker can be used as a separate branch from the rest of the node tree. Once the tracking is completed, a Planar Transform node should be generated to use the planar tracking data.

A Planar Tracker can be isolated on its own branch of a node tree.

**A Typical Planar Tracker Workflow**

The following steps outline the workflow with the Planar Tracker:

1. **Remove lens distortion:** The more lens distortion in the footage, the more the resulting track will slide and wobble.
2. **Connect footage:** Connect a Loader or MediaIn node that contains a planar surface to the orange background input and view the Planar Tracker node in a viewer.
3. **Select a reference frame:** Move to a frame where the planar surface to be tracked is not occluded and click the Set button to set this as a reference frame.
4. **Choose the pattern:** In the viewer, make sure the onscreen controls are visible, and draw a polygon around the planar surface you want to track. This is called the “pattern.” In most cases, this will probably be a rectangle, but an arbitrary closed polygon can be used. The pixels enclosed by this region will serve as the pattern that will be searched for on other frames. Note that it is important that the pattern is drawn on the reference frame. Do not confuse the pattern with the region to corner pin (which always has four corners and is separately specified in Corner Pin mode).
5. **Adjust render range:** In the Keyframes Editor, adjust the render range to match the range of frames where the planar surface is visible.
6. **Adjust track options:** Frequently changed options include Tracker, Motion Type, and Track Channel.
7 **Mask out occluders:** If moving objects partially cover up the planar surface, you may wish to connect an occlusion mask to the Planar Tracker. When using the Hybrid tracker, providing a mask to deal with occluding objects is strongly recommended, while with the Point tracker it is recommended to try tracking without a mask.

8 **Track:** Click the Go button to return to the reference frame. Press the Track To End button and wait for the track to complete. Click the Go button to return to the reference frame again. Press the Track To Start button and wait for the track to complete. Note that the tracks in the viewer are not selectable or deletable as they are in a Camera Tracker.

9 **Check track quality:** Visually inspect the track to see how accurate it is. Does it stick to the surface? Switching to Steady mode can help here.

10 **Use the track:** At this point, in most cases you will create a Planar Transform node from the Inspector and use it to apply the tracked perspective distortion onto masked images. If the image you are applying the tracking data to is full frame unmasked clip, you can use the Steady, Corner Pin, and Stabilize operation modes in in the Planar Tracker.

**Inspector**

The Planar Tracker Controls tab

**Controls Tab**

The Controls tab contains controls for determining how the Planar Tracker will be used, setting the reference frame and initiating the track.

**Operation Mode**

The Operation Mode menu selects the purpose of the Planar Tracker node. The Planar Tracker has four modes of operation:

- **Track:** Used to isolate a planar surface and track its movement over time. Then, you can create a Planar Transform node that uses this data to match move another clip in various ways.

- **Steady:** After analyzing a planar surface, this mode removes all motion and distortions from the planar surface, usually in preparation for some kind of paint or roto task, prior to “unsteadying” the clip to restore the motion.

- **Corner Pin:** After analyzing a planar surface, this mode computes and applies a matching perspective distortion to a foreground image you connect to the foreground input of the Planar Tracker node, and merges it on top of the tracked footage.

- **Stabilize:** After analyzing a planar surface, this mode allows smoothing of a clip’s translation, rotation, and scale over time. This is good for getting unwanted vibrations out of a clip while retaining the overall camera motion that was intended.
The last three modes (Steady, Corner Pin, and Stabilize) use the tracking data produced in Track mode.

**NOTE:** None of the operations can be combined together. For example, both Corner Pin and Stabilize cannot be done at the same time, nor can a track be done while in corner pinning mode.

**Reference Time**

The Reference Time determines the frame where the pattern is outlined. It is also the time from which tracking begins. The reference frame cannot be changed once it has been set without destroying all pre-existing tracking information, so scrub through the footage to be tracked and choose carefully. The reference frame must be chosen carefully to give the best possible quality track.

You choose a reference frame by moving the playhead to an appropriate frame and then clicking the Set button to choose that frame.

**Pattern Polygon**

You specify which region of the image you want to track by drawing a polygon on the reference frame. Typically, when you first add a Planar Tracker node, you are immediately ready to start drawing a polygon in the viewer, so it’s best to do this right away. When choosing where to draw a polygon, make sure the region selected belongs to a physically planar surface in the shot. In a pinch, a region that is only approximately planar can be used, but the less planar the surface, the poorer the quality of the resulting track.

As a rule of thumb, the more pixels in the pattern, the better the quality of the track. In particular, this means the reference frame pattern should be:

- As large as possible.
- As much in frame as possible.
- As unoccluded as possible by any moving foreground objects.
- At its maximal size (e.g., when tracking an approaching road sign, it is good to pick a later frame where it is 400 x 200 pixels big rather than 80 x 40 pixels).
- Relatively undistorted (e.g., when the camera orbits around a flat stop sign, it is better to pick a frame where the sign is face-on parallel to the camera rather than a frame where it is at a highly oblique angle).

If the pattern contains too few pixels or not enough trackable features, this can cause problems with the resulting track, such as jitter, wobble, and slippage. Sometimes dropping down to a simpler motion type can help in this situation.

After you’ve drawn a pattern, a set of Pattern parameters lets you transform and invert the resulting polygon, if necessary.

**Track Mode**

Track mode is unlike the other three options in the Operation menu in that is the only option that initiates the planar tracking. The other modes use the tracking data generated by the Track mode.

**Tracker**

There are two available trackers to pick from:

- **Point:** Tracks points from frame to frame. Internally, this tracker does not actually track points-per-se but rather small patterns like Fusion’s Tracker node. The point tracker possesses the ability to automatically create its internal occlusion mask to detect and reject outlier tracks that do not belong to the dominant motion. Tracks are colored green or red in the viewer, depending on whether the point tracker thinks they belong to the dominant motion or they have been rejected. The user can optionally supply an external occlusion mask to further guide the Point tracker.
– **Hybrid Point/Area**: Uses an Area tracker to track all the pixels in the pattern. Unlike the Point tracker, the Area tracker does not possess the ability to automatically reject parts of the pattern that do not belong to the dominant motion, so you must manually provide it with an occlusion mask. Note that for performance reasons, the Hybrid tracker internally first runs the Point tracker, which is why the point tracks can still be seen in the viewer.

There is no best tracker. They each have their advantages and disadvantages:

– **Artist Effort (occlusion masks)**: The Point tracker will automatically create its internal occlusion mask. However, with the Hybrid tracker, you need to spend more time manually creating occlusion masks.

– **Accuracy**: The Hybrid tracker is more accurate and less prone to wobble, jitter, and drift since it tracks all the pixels in the pattern rather than a few salient feature points.

– **Speed**: The Hybrid tracker is slower than the Point tracker.

In general, it is recommended to first quickly track the shot with the Point tracker and examine the results. If the results are not good enough, then try the Hybrid tracker.

**Motion Type**

Determines how the Planar Tracker internally models the distortion of the planar surface being tracked. The five distortion models are:

– Translation.

– Translation, Rotation (rigid motions).

– Translation, Rotation, Scale (takes squares to squares, scale is uniform in x and y).

– Affine includes translation, rotation, scale, skew (maps squares to parallelograms).

– Perspective (maps squares to generic quadrilaterals).

Each successive model is more general and includes all previous models as a special case.

When in doubt, choose Perspective for the initial track attempt. If the footage being tracked has perspective distortions in it, and the Planar Tracker is forced to work with a simpler motion type, this can end up causing the track to slide and wobble.

Sometimes with troublesome shots, it can help to drop down to a simpler motion model—for example, when many track points are clustered on one side of the tracked region or when tracking a small region where there are not many trackable pixels.

**Output**

Controls what is output from the Planar Tracker node while in the Track operation mode.

– **Background**: Outputs the input image unchanged.

– **Background - Preprocessed**: The Planar Tracker does various types of preprocessing on the input image (e.g., converting it to luma) before tracking. It can be useful to see this when deciding which track channel to choose.

– **Mask**: Outputs the pattern as a black and white mask.

– **Mask Over Background**: Outputs the pattern mask merged over the background.

**Track Channel**

Determines which image channel in the background image is tracked. It is good to pick a channel with high contrast, lots of trackable features, and low noise. Allowed values are red, green, blue, and luminance.
**Tracking Controls**

These controls are used to control the Tracker. Note that while tracking, only track to a new frame if the current frame is already tracked or it is the reference frame.

- **Track to start**: Tracks from the current frame backward in time to the start (as determined by the current render range).
- **Step tracker to previous frame**: Tracks from the current frame to the previous frame.
- **Stop tracking**: Stops any ongoing tracking operations.
- **Step tracker to next frame**: Tracks from the current frame to the next frame.
- **Track to end**: Tracks from the current frame forward in time to the end (as determined by the current render range).
- **Trim to start**: Removes all tracking data before the current frame.
- **Delete**: Deletes all tracking data at all times. Use this to destroy all current results and start tracking from scratch.
- **Trim to end**: Removes all tracking data after the current frame. This can be useful, for example, to trim the end of a track that has become inaccurate when the pattern starts to move off frame.

**Show Splines**

This button to the right of the “Trim to end” button opens the Spline Editor and shows the splines associated with the Planar Tracker node. This can be useful for manually deleting points from the Track and Stable Track splines.

**Right-Click Here for Track Spline**

While tracking, a spline containing 4 x 4 matrices at each keypoint is created. This is known as the “Track spline” or just “Track” for short. These matrices completely describe the distortions of the tracked pattern.

**Create Planar Transform**

After tracking footage, this button can be pressed to create a Planar Transform node on the Node Editor. The current tracking data is embedded in the Planar Transform node so that it can replicate the planar distortions tracked by the Planar Tracker node. Unless you are compositing a full frame foreground that matches the same dimensions as the raster, it is best to create a Planar Transform and use it to apply motion to the foreground.

**Steady Mode**

In Steady mode, the Planar Tracker transforms the background plate to keep the pattern as motionless as possible. Any leftover motion is because the Planar Tracker failed to follow the pattern accurately or because the pattern did not belong to a physically planar surface.

Steady mode is not very useful for actual stabilization, but is useful for checking the quality of a track. If the track is good, during playback the pattern should not move at all while the rest of the background plate distorts around it. It can be helpful to zoom in on parts of the pattern and place the mouse cursor over a feature and see how far that feature drifts away from the mouse cursor over time.

**Steady Time**

This is the time where the pattern’s position is snapshotted and frozen in place. It is most common to set this to the reference frame.

**Invert Steady Transform**

This causes the Planar Tracker node to reverse the effects of the steady transform. This means two Planar Tracker nodes connected back to back with the second set to invert should give back the original image. If you place an effects node in between the two, then the effect will be locked in place.
This should only be used to accomplish effects that cannot be done through corner pinning, since it involves two resamplings, causing softening of the background image.

**Clipping Mode**

Determines what happens to the parts of the background image that get moved off frame by the steady transform:

- **Domain:** The off frame parts are kept.
- **Frame:** The off frames parts are thrown away.

Domain mode is useful when Steady mode is being used to “lock” an effect to the pattern. As an example, consider painting on the license plate of a moving car. One way to do this is to use a Planar Tracker node to steady the license plate, then a Paint node to paint on the license plate, and then a second Planar Tracker to undo the steady transform. If the Clipping mode is set to Domain, the off frame parts generated by the first Planar Tracker are preserved so that the second Planar Tracker can, in turn, map them back into the frame.

**Corner Pin Mode**

In Corner Pin mode, one or more textures can be attached to a previously tracked planar surface and undergo the same perspective distortions as the surface.

The corner pin workflow with Planar Tracker is:

1. **Track:** select a planar surface in the shot that you wish to attach a texture to or replace the texture on. Track the shot (see the tracking workflow in the Track section).

2. **Switch the Operation Mode to Corner Pin:** When Corner Pin mode is entered from Track mode, the pattern polygon is hidden and a corner pin control is shown in the viewer.

3. **Connect in the texture:** In the Node Editor, connect the output of the MediaIn node containing the texture to the Corner Pin 1 input on the Planar Tracker node.

4. **Adjust corner pin:** Drag the corners of the corner pin in the viewer until the texture is positioned correctly. Sometimes the Show Grid option is useful when positioning the texture. Additionally, if it helps to position it more accurately, scrub to other times and make adjustments to the corner pin.

5. **Review:** Play back the footage and make sure the texture “sticks” to the planar surface.

**Merge Mode**

Controls how the foreground (the corner pinned texture) is merged over the background (the tracked footage). If there are multiple corner pins, this option is shared by all of them. There are four options to pick from:

- **BG only**
- **FG only**
- **FG over BG**
- **BG over FG**

**Number of Corner Pins**

Use the + and - buttons to increase or decrease the number of corner pins. Each time an additional corner pin is created, a corresponding input appears on the node in the Node Editor.

**Corner Pin 1 Input Group**

Each corner pin has a group of related inputs:

- **Enable:** Controls the visibility of the corner pin in the viewer.
- **Show Grid:** Shows a grid over the corner pin. This can be useful when positioning the corners.
— **Merge Options**: Controls merging of corner pin texture over the background. (See the documentation for the Merge node.)

— **Reference Time Positions**: The positions of the four corners at the reference time. If the track was not perfect, these positions can be animated to make adjustments on top of the track.

**Stabilize Mode**

Stabilize mode is used to smooth out shakiness in the camera by applying a transform that partially counteracts the camera shake. This stabilizing transform (contained in the Stable Track spline) is computed by comparing neighboring frames.

**NOTE**: Stabilize mode only smooths out motions, while Steady mode tries to completely “lock off” all motion.

Be aware that the Planar Tracker stabilizes based on the motion of the pattern, so it is essential to choose the pattern carefully. If the motion of the pattern does not represent the motion of the camera, then there may be unexpected results. For example, if tracking the side of a moving truck and the camera is moving alongside it, the Planar Tracker smooths the combined motion of both the truck and the mounted camera. In some cases, this is not the desired effect. It may be better to choose the pattern to be on some fixed object like the road or the side of a building, which would result in smoothing only the motion of the camera.

One unavoidable side effect of the stabilization process is that transparent edges appear along the edges of the image. These edges appear because the stabilizer does not have any information about what lies off frame, so it cannot fill in the missing bits. The Planar Tracker node offers the option to either crop or zoom away these edges. When filming, if the need for post-production stabilization is anticipated, it can sometimes be useful to film at a higher resolution (or lower zoom).

**The Planar Tracker Stabilization Workflow**

1. **Track**: Select a roughly planar region that represents the motion that you want to stabilize. Track the shot (see the tracking workflow in the Track section).

2. **Switch the Operation Mode to Stabilize**: Until a stabilization is computed, the Planar Tracker will just output the input footage.

3. **Adjust stabilization options**: Frequently changed options are Parameters to Smooth and Smoothing Radius.

4. **Compute stabilization**: Press the Compute Stabilization button and wait for the stabilization computations to finish. Play back the output of the Planar Tracker node to see the effects of the stabilization. Notice that transparent edges have been introduced around the edges of the image by the stabilization transform.

5. **Refine**: Adjust the stabilization options and recompute the stabilization as many times as desired.

6. **Handle transparent edges (optional)**: Set the Frame Mode to either Zoom or Crop as desired and then click the Auto Zoom or Auto Crop button. Play back the footage to observe the effects. If there is too much zoom or the image has been cropped too small, try reducing the amount of smoothing.

**Parameters to Smooth**

Specify which of the following parameters to smooth:

— X Translation
— Y Translation
— Rotation
— Scale
Smoothing Window
When stabilizing a particular frame, this determines how the contributions of neighboring frames are weighted. Available choices are Box and Gaussian.

Smoothing Radius (Frames)
Determines the number of frames whose transforms are averaged together to compute the stabilization. A larger Smoothing Radius results in more smoothing but introduces more transparent edges.

Compute Stabilization
Clicking this button runs the stabilizer, overwriting the results of any previous stabilization. As soon as the stabilization is finished, the output of the Planar Tracker node will be immediately updated with the stabilization applied.

NOTE: The stabilizer uses the Track spline (created by the tracker) to produce the Stable Track spline. Both of these splines' keyframes contain 4 x 4 matrices, and the keyframes are editable in the Spline Editor.

Clipping Mode
Determines what happens to the parts of the background image that get moved off frame by the stabilization:

– **Domain:** The off frame parts are kept.
– **Frame:** The off frames parts are thrown away.

Frame Mode
This controls how transparent edges are handled. The available options include:

– **Full:** Do nothing. Leaves the transparent edges as is.
– **Crop:** Crops away the transparent edges. When this option is selected, the size of Planar Tracker's output image is smaller than the input image. No image resamplings occur. In Crop mode, use the Auto Crop button or manually adjust the crop window by changing the X Offset, Y Offset, and Scale sliders.

  – **Auto Crop Button:** When this button is clicked, the Planar Tracker will examine all the frames and pick the largest possible crop window that removes all the transparent edges. The computed crop window will always be centered in frame and pixel aligned. When clicked, Auto Crop updates the X/Y Offset and Scale sliders.

– **Zoom:** Scales the image bigger until the transparent edges are off frame. Choosing this option causes an image resampling to occur. The downside of this approach is that it reduces the quality (slightly softens) of the output image. In Zoom mode, use the Auto Zoom button or manually adjust the zoom window by changing the X Offset, Y Offset, and Scale sliders.

  – **Auto Zoom:** When this button is clicked, the Planar Tracker will examine all the frames and pick the smallest possible zoom factor that removes all the transparent edges. The computed zoom window will always be centered in frame. When clicked, Auto Zoom updates the X/Y Offset and Scale sliders.
Right-Click Here for Stable Track Spline
Right-clicking over this label provides access to a spline whose keyframes contain 4 x 4 matrices
which in turn represent the stabilization transforms. This is mostly here for completeness and for
advanced users.

Options Tab
These controls affect the look of onscreen controls in the viewer.

The Planar Tracker Options tab

Darken Image
Darkens the image while in Track mode in order to better see the controls and tracks in the viewer.
The Shift+D keyboard shortcut toggles this.

Show Track Markers
Toggles the display of the dots marking the location of trackers at the current time.

Show Trails
Toggles the display of the trails following the location of trackers.

Trail Length
Allows changing the length of tracker trails. If the pattern is moving very slowly, increasing the length
can sometimes make the trails easier to follow in the viewer. If the pattern is moving very fast, the
tracks can look like spaghetti in the viewer. Decreasing the length can help.

Inlier/Outlier Colors
When tracking, the tracker analyzes the frame and detects which of the multitudinous tracks belong to
the dominant motion and which ones represent anomalous, unexplainable motion. By default, tracks
belonging to the dominant motion are colored green (and are called inliers) and those that do not
belong are colored red (and are called outliers). Only the inlier tracks are used when computing the
final resulting track.

Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other Tracking nodes. These common controls
are described in detail at the end of this chapter in "The Common Controls" section.
Planar Transform Node [PXF]

The Planar Transform node applies perspective distortions generated by a Planar Tracker node onto any input mask or masked image. The Planar Transform node can be used to reduce the amount of time spent on rotoscoping objects. The workflow here centers around the notion that the Planar Tracker node can be used to track objects that are only roughly planar. After an object is tracked, a Planar Transform node can then be used to warp a rotospline, making it approximately follow the object over time. Fine-level cleanup work on the rotospline then must be done.

Depending on how well the Planar Tracker followed the object, this can result in substantial time savings in the amount of tedious rotoscoping. The key to using this technique is recognizing situations where the Planar Tracker performs well on an object that needs to be rotoscoped.

A rough outline of the workflow involved is:

1. **Track**: Using a Planar Tracker node, select a pattern that represents the object to be rotoscoped. Track the shot (see the tracking workflow in the Track section for the Planar Tracker node).

2. **Create a Planar Transform node**: Press the Create Planar Transform button on the Planar Tracker node to do this. The newly created Planar Transform node can be freely cut and pasted into another composition as desired.

3. **Rotoscope the object**: Move to any frame that was tracked by the Planar Tracker. When unsure if a frame was tracked, look in the Spline Editor for a tracking keyframe on the Planar Transform node. Connect a Polygon node into the Planar Transform node. While viewing the Planar Transform node, rotoscope the object.

4. **Refine**: Scrub the timeline to see how well the polygon follows the object. Adjust the polyline on frames where it is off. It is possible to add new points to further refine the polygon.

**Inputs**

The Planar Transform has only two inputs:

- **Image Input**: The orange image input accepts a 2D image on which the transform will be applied.

- **Effect Mask**: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the output of the Planar Transform to certain areas.

**Basic Node Setup**

The example below uses a Planar Transform node between a masked MediaIn2 node and the foreground input to a Merge node. The background MediaIn1 node connects to the Planar Tracker, which was used to generate the Planar Transform. Once the Planar Transform is created, the Planar Tracker is no longer needed in the node tree.
A Planar Transform creating a match move

**Inspector**

![Planar Transform Controls tab](image)

**Controls Tab**

The Planar Transform node has very few controls, and they are all located in the Controls tab. It’s designed to apply the analyzed Planar Tracking data as a match move,

**Reference Time**

This is the reference time that the pattern was taken from in the Planar Tracker node used to produce the Planar Transform.

**Right-Click Here for Track Spline**

The Track spline contains information about the perspective distortions stored in 4 x 4 matrices. When a Planar Transform node is exported from a Planar Tracker node, the Track spline produced by the Planar Tracker is shared by connecting it with the Planar Transform node. A consequence of this sharing of the Track spline is that if the track is changed in the Planar Tracker node, the Planar Transform will be automatically updated. Note that this spline can be examined in the Spline Editor, which is useful for seeing the extent of tracked frames.

**Common Controls**

**Settings Tab**

The Settings tab in the Inspector is also duplicated in other Tracking nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
Camera Tracker Introduction

Camera tracking is match moving, and a vital link between 2D and 3D, allowing compositors to integrate 3D renders into live-action scenes. The Camera Tracker node is used to calculate the path of a live-action camera and generate a virtual camera in 3D space. This virtual camera’s motion is intended to be identical to the motion of the actual camera that shot the scene. Using the calculated position and movement of the virtual camera provides the flexibility to add 3D elements to a live-action scene. Also, the Camera Tracker creates a point cloud in 3D space that can be used to align objects and other 3D models to the live-action scene.

For more information about how to use the Camera Tracker, see Chapter 26, “3D Camera Tracking” in the Fusion Reference Manual or Chapter 87, in the DaVinci Resolve Reference Manual.
**Inputs**

The Camera Tracker has two inputs:

- **Background**: The orange image input accepts a 2D image you want tracked.
- **Occlusion Mask**: The white occlusion mask input is used to mask out regions that do not need to be tracked. Regions where this mask is white will not be tracked. For example, a person moving in front of and occluding bits of the scene may be confusing to the tracker, and a quickly-created rough mask around the person can be used to tell the tracker to ignore the masked-out bits.

**Basic Node Setup**

The Camera Tracker background input is used to connect the image you want tracked. Polygon masks can be connected into the occlusion mask input to identify areas the tracker should ignore.

![The Camera Tracker with occlusion masks](image)

**Inspector**

![The Camera Tracker tab](image)

**Track Tab**

The Track tab contains the controls you need to set up an initial analysis of the scene.

**Auto Track**

Automatically detects trackable features and tracks them through the source footage. Tracks will be automatically terminated when the track error becomes too high, and new tracks are created as needed. The values of the Detection Threshold and Minimum Feature Separation sliders can be used to control the number and distribution of auto tracks.
Reset
Deletes all the data internal to the Camera Tracker node, including the tracking data and the solve data (camera motion path and point cloud). To delete only the solve data, use the Delete button on the Solve tab.

Preview AutoTrack Locations
Turning this checkbox on will show where the auto tracks will be distributed within the shot. This is helpful for determining if the Detection Threshold and Minimum Feature Separation need to be adjusted to get an even spread of trackers.

Detection Threshold
Determines the sensitivity to detect features. Automatically generated tracks will be assigned to the shot and the Detection Threshold will force them to be either in locations of high contrast or low contrast.

Minimum Feature Separation
Determines the spacing between the automatically generated tracking points. Decreasing this slider causes more auto tracks to be generated. Keep in mind that a large number of tracking points will also result in a lengthier solve.

Track Channel
Used to nominate a color channel to track: red, green, blue, or luminance. When nominating a channel, choose one that has a high level of contrast and detail.

Track Range
Used to determine which frames are tracked:
- Global: The global range, which is the full duration of the Timeline.
- Render: The render duration set on the Timeline.
- Valid: The valid range is the duration of the source media.
- Custom: A user determined range. When this is selected, a separate range slider appears to set the start and end of the track range.

Bidirectional Tracking
Enabling this will force the tracker to track backward after the initial forward tracking. When tracking backward, new tracks are not started but rather existing tracks are extended backward in time. It is recommended to leave this option on, as long tracks help give better solved cameras and point clouds.

Gutter Size
Trackers can become unstable when they get close to the edge of the image and either drift or jitter or completely lose their pattern. The Camera Tracker will automatically terminate any tracks that enter the gutter region. Gutter size is given as a percentage of pattern size. By default, it’s 100% of pattern size, so a 0.04 pattern means a 0.04 gutter.

New Track Defaults
There are three methods in which the Camera Tracker node can analyze the scene, and each has its own strengths when dealing with certain types of camera movement.
- Tracker: Internally, all the Trackers use the Optical Flow Tracker to follow features over time and then further refine the tracks with the trusted Fusion Tracker or Planar Tracker. The Planar Tracker method allows the pattern to warp over time by various types of transforms to find the best fit. These transforms are:
  - Translation
  - Translation and Rotation Translation, Rotation, and Scale Affine
  - Perspective
It is recommended to use the default TRS setting when using the Planar Tracker. The Affine and Perspective settings need large patterns in order to track accurately.

- **Close Tracks When Track Error Exceeds:** Tracks will be automatically terminated when the tracking error gets too high. When tracking a feature, a snapshot of the pixels around a feature are taken at the reference time of the track. This is called a pattern, and that same pattern of pixels is searched for at future times. The difference between the current time pattern and the reference time pattern is called the track error. Setting this option higher produces longer but increasingly less accurate tracks.

- **Solve Weight:** By default, each track is weighted evenly in the solve process. Increasing a track’s weight means it has a stronger effect on the solved camera path. This is an advanced option that should be rarely changed.

**Auto Track Defaults**
Set a custom prefix name and/or color for the automatically generated tracks. This custom color will be visible when Track Colors in the Options tab is set to User Assigned.

**Camera Tab**

The controls of the Camera tab let you specify the physical aspects of the live-action camera, which will be used as a starting point when searching for solve parameters that match the real-world camera. The more accurate the information provided in this section, the more accurate the camera solve.

The Camera tab includes controls relating to the lens and gate aspects of the camera being solve for.

**Focal Length**
Specify the known constant focal length used to shoot the scene or provide a guess if the Refine Focal Length option is activated in the Solve tab.

**Film Gate**
Choose a film gate preset from the drop-down menu or manually enter the film back size in the Aperture Width and Aperture Height inputs. Note that these values are in inches.

**Aperture Width**
In the event that the camera used to shoot the scene is not in the preset drop-down menu, manually enter the aperture width (inches).

**Aperture Height**
In the event that the camera used to shoot the scene is not in the preset drop-down menu, manually enter the aperture height (inches).
Resolution Gate Fit
This defines how the image fits the sensor size. Often, film sensors are sized to cover a number of formats, and only a portion of the sensor area is recorded into an image.

For example, a 16:9 image is saved out of a full aperture-sized sensor.

Typically, fit to Width or Height is the best setting. The other fit modes are Inside, Outside, or Stretched.

Center Point
This is where the camera lens is aligned to the camera. The default is (0.5, 0.5), which is the middle of the sensor.

Use Source Pixel Aspect
This will use the squeeze aspect of the pixels that is loaded in the image. HD is square pixels, but NTSC has a pixel aspect ratio of 0.9:1, and Anamorphic CinemaScope is 2:1 aspect. Disabling this option exposes Pixel X and Y number fields where you can customize the source pixel aspect.

Auto Camera Planes
When enabled, the camera's image plane and far plane are automatically moved to enclose the point cloud whenever a solve completes. Sometimes, though, the solver can atypically fling points off really deep into the scene, consequently pushing the image plane very far out. This makes the resulting scene unwieldy to work with in the 3D views. In these cases, disable this option to override this default behavior (or delete the offending tracks).

Solve Tab

The Camera Tracker Solve tab
SolveTab

The Solve tab is where the tracking data is used to reconstruct the camera's motion path along with the point cloud. It is also where cleanup of bad or false tracks is done, and other operations on the tracks can be performed, such as defining which marks are exported in the Point Cloud 3D. The markers can also have their weight set to affect the solve calculations.

For example, a good camera solve may have already been generated, but there are not enough locators in the point cloud in an area where an object needs to be placed, so adding more tracks and setting their Solve Weight to zero will not affect the solved camera but will give more points in the point cloud.

Solve

Pressing Solve will launch the solver, which uses the tracking information and the camera specifications to generate a virtual camera path and point cloud, approximating the motion of the physical camera in the live-action footage. The console will automatically open, displaying the progress of the solver.

Delete

Delete will remove any solved information, such as the camera and the point cloud, but will keep all the tracking data.

Average Solve Error

Once the camera has been solved, a summary of the solve calculation is displayed at the top of the Inspector. Chief among those details is the Average Solve Error. This number is a good indicator of whether the camera solve was successful. It can be thought of as the difference (measured in pixels) between tracks in the 2D image and the reconstructed 3D locators reprojected back onto the image through the reconstructed camera. Ultimately, in trying to achieve a low solve error, any value less than 1.0 pixels will generally result in a good track. A value between 0.6 and 0.8 pixels is considered excellent.

Clean Tracks by Filter

Clicking this button selects tracks based on the Track Filtering options. If the Auto Delete Tracks By Filter checkbox is activated, the selected tracks will be deleted as well.

Clean Foreground Tracks

Clicking this button makes a selection of the tracks on fast-moving objects that would otherwise cause a high solve error. The selection is determined by the Foreground Threshold slider.

Foreground Threshold

This slider sets the detection threshold for finding the tracks on fast-moving objects. The higher the value, the more forgiving.

Auto Delete Tracks by Filter

With this checkbox enabled, tracks that are selected by the Clean Tracks By Filter button will be deleted. Enable the checkbox, and then press Clean Tracks By Filter. Any track that meets the filtering options is then selected and deleted.

Auto Delete Foreground Tracks

With this checkbox enabled, tracks that are selected by the Clean Foreground Tracks button will be deleted. Enable the checkbox, and then press Clean Foreground Tracks. Any track that meets the foreground threshold criteria is deleted.

Accept Solve Error

This slider sets an acceptable maximum threshold level for the solve error. If the solve error is greater than this value, the Camera Tracker will sweep the focal length setting in an attempt to bring the solve error under the Accept Solve Error value. If the solver cannot find a solution, the Camera Tracker will...
display a message in the console that the solver failed. If a solution cannot be found, ideally you should try to input the correct focal length or alternatively manually clean some noisy tracks then re-solve.

**Auto Select Seed Frames**

With this enabled, the Camera Tracker nominates two frames that will be used as a reference for initiating the solve. These two frames are initially solved for and a camera is reconstructed, and then gradually more frames are added in, and the solution is “grown” outward from the seed frames. The choice of seed frames strongly affects the entire solve and can easily cause the solve to fail. Seed frames can be found automatically or defined manually.

Disabling this will allow the user to select their own two frames. Manual choice of seed frames is an option for advanced users. When choosing seed frames, it is important to satisfy two conflicting desires: the seed frames should have lots of tracks in common yet be far apart in perspective (i.e., the baseline distance between the two associated cameras is long).

**Refine Focal Length**

Enabling this will allow the solver to adjust the focal length of the lens to match the tracking points. You can prevent the focal length being adjusted by setting the Focal Length parameter in the Camera Tab.

**Enable Lens Parameter**

When enabled, lens distortion parameters are exposed to help in correcting lens distortion when solving.

- **Refine Center Point:** Normally disabled, camera lenses are normally centered in the middle of the film gate but this may differ on some cameras. For example, a cine camera may be set up for Academy 1.85, which has a sound stripe on the left, and shooting super35, the lens is offset to the right.

- **Refine Lens Parameters:** This will refine the lens distortion or curvature of the lens. There tends to be larger distortion on wide angle cameras.

---

**NOTE:** When solving for the camera’s motion path, a simulated lens is internally created to model lens distortion in the source footage. This simulated lens model is much simpler than real-world lenses but captures the lens distortion characteristics important for getting an accurate camera solve. Two types of distortion are modeled by Camera Tracker:

- **Radial Distortion:** The strength of this type of distortion varies depending on the distance from the center of the lens. Examples of this include pincushion, barrel, and mustache distortion. Larger values correspond to larger lens curvatures. Modeling radial distortion is especially important for wide angle lenses and fisheye lenses (which will have a lot of distortion because they capture 180 degrees of an environment and then optically squeeze it onto a flat rectangular sensor).

- **Tangential Distortion:** This kind of distortion is produced when the camera’s imaging sensor and physical lens are not parallel to each other. It tends to produce skew distortions in the footage similar to distortions that can be produced by dragging the corners of a corner pin within Fusion. This kind of distortion occurs in very cheap consumer cameras and is practically non-existent in film cameras, DSLRs, and pretty much any kind of camera used in film or broadcast. It is recommended that it be left disabled.

**Enable Lens Parameters**

When disabled, the Camera Tracker does not do any lens curvature simulations. This is the default setting and should remain disabled if there is a very low distortion lens or the lens distortion has already been removed from the source clip. Activating the Enable Lens Parameters checkbox
determines which lens parameters will be modeled and solved for. Parameters that are not enabled will be left at their default values. The following options are available:

- **Radial Quadratic**: Model only Quadratic radial lens curvature, which is either barrel or pincushion distortion. This is the most common type of distortion. Selecting this option causes the low and high order distortion values to be solved for.

- **Radial Quartic**: Model only Quartic radial lens curvature, which combines barrel and pincushion distortion. This causes the low and high order distortion values to be solved for.

- **Radial & Tangential**: Model and solve for both radial and tangential distortion. Tangential relates to misaligned elements in a lens.

- **Division Quadratic**: Provides a more accurate simulation of Quadratic radial lens curvature. This causes the low and high order distortion values to be solved for.

- **Division Quartic**: Provides a more accurate simulation of Quartic radial lens curvature. This causes the low and high order distortion values to be solved for.

- **Lower Order Radial Distortion**: This slider is available for all simulations. It determines the quadratic lens curvature.

- **Higher Order Radial Distortion**: This slider is available only for Quartic simulations. Determines the quartic lens curvature.

- **Tangential Distortion X/Y**: These sliders are available only for Tangential simulations. Determines skew distortion.

**Track Filtering**

The Camera Tracker can produce a large number of automatically generated tracks. Rather than spending a lot of time individually examining the quality of each track, it is useful to have some less time-intensive ways to filter out large swaths of potentially bad tracks. The following input sliders are useful for selecting large amounts of tracks based on certain quality metrics, and then a number of different possible operations can be made on them. For example, weaker tracks can selected and deleted, yielding a stronger set of tracks to solve from. Each filter can be individually enabled or disabled.

**Minimum Track Length (Number of Markers)**

Selects tracks that have a duration shorter than the slider’s value. Short tracks usually don’t get a chance to move very far and thus provide less perspective information to the solver than a longer track, yet both short and long tracks are weighted evenly in the solve process, making long tracks more valuable to the solver. Locators corresponding to shorter tracks are also less accurately positioned in 3D space than those corresponding to longer tracks. If the shot has a lot of long tracks, it can be helpful to delete the short tracks. For typical shots, using a value in the range of 5 to 10 is suggested. If there are not a lot of long tracks (e.g., the camera is quickly rotating, causing tracks to start and move off frame quickly), using a value closer to 3 is recommended.

**Maximum Track Error**

Selects tracks that have an average track error greater than the slider’s value. When tracking, tracks are automatically terminated when their track error exceeds some threshold. This auto termination controls the maximum track error, while this slider controls the average track error. For example, tracks following the foliage in a tree tend to be inaccurate and sometimes may be detected by their high average error.

**Maximum Solve Error**

Selects tracks that have a solve error greater than the slider’s value. One of the easiest ways to increase the accuracy of a camera solve is to select the 20% of the tracks with the highest solve error and simply delete them (although this can sometimes make things worse).
**Select Tracks Satisfying Filters**
Selects the tracks within the scene that meet the above Track Filtering values. Note that when this button is pressed, the tracks that satisfy the filter values are displayed in the Selected Tracks area of the Solve tab and are colored in the viewer. This button is useful when Auto Select Tracks While Dragging Sliders is turned off or if the selection, for example, was accidentally lost by mis-clicking in the viewer.

**Auto Select Tracks While Dragging Sliders**
When this is ticked on, dragging the above sliders (Minimum Track Length, Maximum Track Error, Maximum Solve Error) will cause the corresponding tracks to be interactively selected in the viewer.

**Operations on Selected Tracks**
Tracks selected directly in the viewer with the mouse or selected via track filtering can have the following operations applied:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Will remove the tracks from the set. When there are bad tracks, the simplest and easiest option is to simply delete them.</td>
</tr>
<tr>
<td>Trim Previous</td>
<td>Will cut the tracked frames from the current frame to the start of the track. Sometimes it can be more useful to trim a track than deleting it. For example, high quality long tracks that become inaccurate when the feature they are tracking starts to become occluded or when the tracked feature moves too close to the edge of the image.</td>
</tr>
<tr>
<td>Trim Next</td>
<td>Will cut the tracked frames from the current frame to the end of the track.</td>
</tr>
<tr>
<td>Rename</td>
<td>Will replace the current auto generated name with a new name.</td>
</tr>
<tr>
<td>Set Color</td>
<td>Will allow for user assigned color of the tracking points.</td>
</tr>
<tr>
<td>Export Flag</td>
<td>This controls whether the locators corresponding to the selected tracks will be exported in the point cloud. By default all locators flagged as exportable.</td>
</tr>
<tr>
<td>Solve Weight</td>
<td>By default, all the tracks are used and equally weighted when solving for the camera's motion path. The most common use of this option is to set a track's weight to zero so it does not influence the camera's motion path but is still has a reconstructed 3D locator. Setting a tracks' weight to values other than 1.0 or 0.0 should only be done by advanced users. Onscreen display of track names and values are controlled by these functions:</td>
</tr>
<tr>
<td>None</td>
<td>Will clear-hide the selected tracks.</td>
</tr>
<tr>
<td>Toggle</td>
<td>Will swap the selected tracks and unselect sets.</td>
</tr>
<tr>
<td>All</td>
<td>Will select all tracks.</td>
</tr>
<tr>
<td>Show Names</td>
<td>Will display the track name, by default these are a number.</td>
</tr>
<tr>
<td>Show Frame Range</td>
<td>Will display the start and end frame of a track.</td>
</tr>
<tr>
<td>Show Solve Error</td>
<td>Will display the amount of solve error each selected track has.</td>
</tr>
</tbody>
</table>
Selected Tracks
This area displays the properties of a track point or group of points. It has options to:

- **Clear**: Deselects all tracks and clears this area.
- **Invert**: Deselects the current selected tracks and selects the other tracks.
- **Visible**: Selects all the trackers at the current frame.
- **All**: Selects all trackers on all frames.
- **Search**: Selects tracks whose names contain a substring.

**TIP**: Also select tracks directly in the 2D viewer using the mouse or in the 3D viewer by selecting their corresponding locators in the point cloud.

Export Tab
The Export tab lets you turn the tracked and solved data this node has generated into a form that can be used for compositing.

The Camera Tracker Export tab
Export
The Export button will create a basic setup that can be used for 3D match moving:

– A Camera 3D with animated translation and rotation that matches the motion of the live-action camera and an attached image plane.
– A Point Cloud 3D containing the reconstructed 3D positions of the tracks.
– A Shape 3D set to generate a ground plane.
– A Merge 3D merging together the camera, point cloud, and ground plane. When the Merge 3D is viewed through the camera in a 3D viewer, the 3D locators should follow the tracked footage.
– A Renderer 3D set to match the input footage.

The export of individual nodes can be enabled/disabled in the Export Options tab.

Update Previous Export
When this button is clicked, the previously exported nodes are updated with any new data generated. These previously exported nodes are remembered in the Previous Export section at the bottom of this section. Here’s an example of how this is handy:

1 Solve the camera and export.
2 Construct a complex Node Editor based around the exported nodes for use in set extension.
3 The camera is not as accurate as preferred or perhaps the solver is rerun to add additional tracks to generate a denser point cloud. Rather than re-exporting the Camera 3D and Point Cloud 3D nodes and connecting them back in, just press the Update Previous Export button to “overwrite” the existing nodes in place.

Automatically Update Previous Export After Solves
This will cause the already exported nodes (Camera 3D, Point Cloud 3D, Lens Distort, Renderer 3D, and the ground plane) to auto update on each solve.

3D Scene Transform
Although the camera is solved, it has no idea where the ground plane or center of the scene is located. By default, the solver will always place the camera in Fusion’s 3D virtual environment so that on the first frame it is located at the origin (0, 0, 0) and is looking down the -Z axis. You have the choice to export this raw scene without giving the Camera Tracker any more information, or you can set the ground plane and origin to simplify your job when you begin working in the 3D scene. The 3D Scene Transform controls provide a mechanism to correctly orient the physical ground plane in the footage with the virtual ground plane in the 3D viewer. Adjusting the 3D Scene Transform does not modify the camera solve but simply repositions the 3D scene to best represent the position of the live-action camera.

**NOTE:** If you export the scene and then make changes in the 3D Scene Transform, it is important to manually click Update Previous Export to see the results in the exported nodes.

Aligned/Unaligned
The Aligned/Unaligned menu locks or unlocks the origin and ground plane settings. When set to Unaligned, you can select the ground plane and origin either manually or by selecting locators in the viewer. When in unaligned mode, a 3D Transform control in the 3D viewer can be manually manipulated to adjust the origin.

Once alignment of the ground plane and origin has been completed, the section is locked by switching the menu to Aligned.
Set from Selection
When set to unaligned, buttons labeled Set from Selection are displayed under the Origin, Orientation, and Scale sections. Clicking these buttons takes the selecting locators in the viewer and aligns the ground plane or origin based on the selection.

For instance, to set the ground plane, do the following:

1. After solving, set the 3D Scene Transform menu to Unaligned.
2. Find a frame where the ground plane is at its largest and clearest point.
3. In the viewer, drag a selection rectangle around all the ground plane locators.
4. Hold Shift and drag again to add to the selection.
5. In the Orientation section, make sure the Selection Is menu correctly matches the orientation of the selected locators.
6. Click the Set from Selection button located under the Orientation parameters.
7. Set the 3D Scene Transform menu back to Aligned.

To get the best result when setting the ground plane, try to select as many points as possible belonging to the ground and having a wide separation.

**TIP:** When selecting points for the ground plane, it is helpful to have the Camera Tracker node viewed in side-by-side 2D and 3D views. It may be easier to select tracks belonging to the ground by selecting tracks from multiple frames in the 2D viewer rather than trying to box select locators in the 3D viewer.

Setting the origin can help you place 3D objects in the scene with more precision. To set the origin, you can follow similar steps, but only one locator is required for the origin to be set. When selecting a locator for the origin, select one that has a very low solve error.

Ground Plane Options
These controls let you adjust the ground plane for the scene, which is a crucial step in making sure the composite looks correct.

<table>
<thead>
<tr>
<th>Color</th>
<th>Will set the color of the ground plane.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Controls how big the ground plane can be set.</td>
</tr>
<tr>
<td>Subdivision Level</td>
<td>Shows how many polygons are in the ground plane.</td>
</tr>
<tr>
<td>Wireframe</td>
<td>Sets whether the ground plane is set as wireframe or solid surface when displayed in 3D.</td>
</tr>
<tr>
<td>Line Thickness</td>
<td>Adjusts how wide the lines will draw in the view.</td>
</tr>
<tr>
<td>Offset</td>
<td>By default, the center of the ground plane is placed at the origin (0, 0, 0). This can be used to shift the ground plane up and down along the y-axis.</td>
</tr>
</tbody>
</table>

Export Options
Provides a checkbox list of what will be exported as nodes when the Export button is pressed. These options are Camera, Point Cloud, Ground Plane, Renderer, Lens Distortion, and Enable Image Plane in the camera.

The Animation menu allows you to choose between animating the camera and animating the point cloud. Animating the camera leaves the point cloud in a locked position while the camera is keyframed to match the live-action shot. Animating the point cloud does the opposite. The camera is locked in position while the entire point cloud is keyframed to match the live-action shot.
**Previous Export**
When the Update Previous Export button is clicked, the previously exported nodes listed here are updated with any new data generated (this includes the camera path and attributes, the point cloud, and the renderer).

**Options Tab**
The Options tab lets you customize the Camera Tracker’s onscreen controls so you can work most effectively with the scene material you have.

![The Camera Tracker Options tab](image)

**Trail Length**
Displays trail lines of the tracks overlaid on the viewer. The amount of frames forward and back from the current frame is set by length.

**Location Size**
In the 3D viewer, the point cloud locators can be sized by this control.

Track Colors, Locator Colors, and Export Colors each have options for setting their color to one of the following:

- User Assigned
- Solve Error
- Take From Image
- White

<table>
<thead>
<tr>
<th>Track Colors</th>
<th>Onscreen tracks in the 2D view.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locator Colors</td>
<td>Point Cloud locators in the 3D view.</td>
</tr>
<tr>
<td>Export Colors</td>
<td>Colors of the locators that get exported within the Point Cloud node.</td>
</tr>
</tbody>
</table>
**Darken Image**
Dims the brightness of the image in viewers to better see the overlaid tracks. This affects both the 2D and 3D viewers.

**Visibility**
Toggles which overlays will be displayed in the 2D and 3D viewers. The options are Tracker Markers, Trails, Tooltips in the 2D Viewer, Tooltips in the 3D viewer, Reprojected Locators, and Tracker Patterns.

**Colors**
Sets the color of the overlays.
- **Selection Color**: Controls the color of selected tracks/locators.
- **Preview New Tracks Color**: Controls the color of the points displayed in the viewer when the Preview AutoTrack Locations option is enabled.
- **Solve Error Gradient**: By default, tracks and locators are colored by a green-yellow-red gradient to indicate their solve error. This gradient is completely user adjustable.

**Reporting**
Outputs various parameters and information to the Console.

**Understanding Camera Tracking**
On large productions, camera tracking or 3D match moving is often handed over to experts who have experience with the process of tracking and solving difficult shots. There is rarely a shot where you can press a couple of buttons and have it work perfectly. It does take an understanding of the whole process and what is essential to get a good solved track.

The Camera Tracker must solve for hundreds of thousands of unknown variables, which is a complex task. For the process to work, it is essential to get good tracking data that exists in the shot for a long time. False or bad tracks will skew the result. This section explains how to clean up false tracks and other techniques to get a good solve.

**Workflow**
Getting a good solve is a repeated process.

Track > Solve > Refine Filters > Solve > Cleanup tracks > Solve > Cleanup from point cloud > Solve > Repeat.

Initially, there are numerous tracks, and not all are good, so a process of filtering and cleaning up unwanted tracks to get to the best set is required. At the end of each cleanup stage, pressing Solve ideally gives you a progressively lower solve error. This needs to be below 1.0 for it to be good for use with full HD content, and even lower for higher resolutions. Refining the tracks often but not always results in a better solve.

**False Tracks**
False tracks are caused by a number of conditions, such as moving objects in a shot, or reflections and highlights from a car. There are other types of false tracks like parallax errors where two objects are at different depths, and the intersection gets tracked. These moiré effects can cause the track to creep. Recognizing these False tracks and eliminating them is the most important step in the solve process.
Track Lengths
Getting a good set of long tracks is essential; the longer the tracks are, the better the solve. The Bi-Directional tracking option in the Tracker tab is used to extend the beginning of tracks in time. The longer in time a track exists and the more tracks that overlap in time of a shot, the more consistent and accurate the solve.

Seed Frames
Two seed frames are used in the solve process. The algorithm chooses two frames that are as far apart in time yet share the same tracks. That is why longer tracks make a more significant difference in the selection of seed frames.

The two Seed frames are used as the reference frames, which should be from different angles of the same scene. The solve process will use these as a master starting point to fit the rest of the tracks in the sequence.

There is an option in the Solve tab to Auto Detect Seed Frames, which is the default setting and most often a good idea. However, auto detecting seed frames can make for a longer solve. When refining the Trackers and re-solving, disable the checkbox and use the Seed 1 and Seed 2 sliders to enter the previous solve’s seed frames. These seed frames can be found in the Solve Summary at the top of the Inspector after the initial solve.

Refine Filters
After the first solve, all the Trackers will have extra data generated. These are solve errors and tracking errors.

Use the refine filters to reduce unwanted tracks, like setting minimum tracker length to eight frames. As the value for each filter is adjusted, the Solve dialog will indicate how many tracks are affected by the filter. Then Solve again.

Onscreen Culling
Under the Options tab, set the track to 20. This will display each track on footage with +20 frame trail. When scrubbing/playing through the footage, false tracks can be seen and selected onscreen, and deleted by pressing the Delete key. This process takes an experienced eye to spot tracks that go bad. Then Solve again.

You can view the exported scene in a 3D perspective viewer. The point cloud will be visible. Move and pan around the point cloud, select and delete points that seem to have no inline with the image and the scene space. Then Solve again.

Repeat the process until the solve error is below 1.0 before exporting.

Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other Tracking nodes. These common controls are described in detail in the following “The Common Controls” section.
The Common Controls

Nodes that handle tracking operations share several identical controls in the Inspector. This section describes controls that are common among Tracking nodes.

Inspector

The Common Tracking Controls Settings tab

Settings Tab

The Settings tab in the Inspector can be found on every tool in the Tracking category. The controls are consistent and work the same way for each tool.

Blend

The Blend control is used to blend between the tool’s original image input and the tool’s final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming image. Normally, this will cause the tool to skip processing entirely, copying the input straight to the output.

Process When Blend Is 0.0

The tool is processed even when the input value is zero. This can be useful if the node is scripted to trigger a task, but the node’s value is set to 0.0.

Red/Green/Blue/Alpha Channel Selector

These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.
For example, if the Red button on a Blur tool is deselected, the blur will first be applied to the image, and then the red channel from the original input will be copied back over the red channel of the result.

There are some exceptions, such as tools for which deselecting these channels causes the tool to skip processing that channel entirely. Tools that do this will generally possess a set of identical RGBA buttons on the Controls tab in the tool. In this case, the buttons in the Settings and the Controls tabs are identical.

Apply Mask Inverted
Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

Multiply by Mask
Selecting this option will cause the RGB values of the masked image to be multiplied by the mask channel’s values. This will cause all pixels of the image not included in the mask (i.e., set to 0) to become black/transparent.

Use Object/Use Material (Checkboxes)
Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports Object ID and Material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels will be used, if present. The specific Material ID or Object ID affected is chosen using the next set of controls.

Correct Edges
This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option is disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information on the Coverage and Background Color channels, see Chapter 18, “Understanding Image Channels” in the Fusion Studio Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.

Object ID/Material ID (Sliders)
Use these sliders to select which ID will be used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker: to grab IDs from the image displayed in the viewer. The image or sequence must have been rendered from a 3D software package with those channels included.

Motion Blur
- **Motion Blur**: This toggles the rendering of Motion Blur on the tool. When this control is toggled on, the tool’s predicted motion is used to produce the motion blur caused by the virtual camera’s shutter. When the control is toggled off, no motion blur is created.
- **Quality**: Quality determines the number of samples used to create the blur. A quality setting of 2 will cause Fusion to create two samples to either side of an object’s actual motion. Larger values produce smoother results but increase the render time.
- **Shutter Angle**: Shutter Angle controls the angle of the virtual shutter used to produce the motion blur effect. Larger angles create more blur but increase the render times. A value of 360 is the equivalent of having the shutter open for one full frame exposure. Higher values are possible and can be used to create interesting effects.
- **Center Bias**: Center Bias modifies the position of the center of the motion blur. This allows for the creation of motion trail effects.
- **Sample Spread**: Adjusting this control modifies the weighting given to each sample. This affects the brightness of the samples.
Use GPU
The Use GPU menu has three settings. Setting the menu to Disable turns off GPU hardware-accelerated rendering. Enabled uses the GPU hardware for rendering the node. Auto uses a capable GPU if one is available and falls back to software rendering when a capable GPU is not available.

Hide Incoming Connections
Enabling this checkbox can hide connection lines from incoming nodes, making a node tree appear cleaner and easier to read. When enabled, empty fields for each input on a node will be displayed in the Inspector. Dragging a connected node from the node tree into the field will hide that incoming connection line as long as the node is not selected in the node tree. When the node is selected in the node tree, the line will reappear.

Comments
The Comments field is used to add notes to a tool. Click in the empty field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

Scripts
Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
Chapter 119

Transform Nodes

This chapter details the Transform nodes available in Fusion.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

Camera Shake [CSH]  2387
Crop [CRP]  2390
DVE [DVE]  2393
Letterbox [LBX]  2395
Resize [RSZ]  2398
Scale [SCL]  2401
Transform [XF]  2404
The Common Controls  2408
Camera Shake Node Introduction

This node can simulate a variety of camera shake-style motions from organic to mechanical. It is not the same as the Shake Modifier, which generates random number values for parameters.

For more information on the Shake modifier, see Chapter 61, "Modifiers" in the Fusion Reference Manual or Chapter 122 in the DaVinci Resolve Reference Manual.

The Camera Shake node concatenates its result with adjacent transformation nodes for higher-quality processing.

Inputs

The two inputs on the Camera Shake node are used to connect a 2D image and an effect mask, which can be used to limit the camera shake area.

- **Input:** The orange input is used for the primary 2D image that shakes.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the camera shake area to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

The Camera Shake background input is used to connect the image you want to transform. Polygon masks can be connected into the occlusion mask input to identify areas the camera shake should ignore.

The Camera Shake node can be connected directly after a MediaIn node or any node providing a 2D output.
The Controls Tab
The Controls tab includes parameters for adjusting the offsets, strength, speed, and frequency of the simulated camera shake movement.

**Deviation X and Y**
These controls determine the amount of shake applied to the image along the horizontal (X) and vertical (Y) axes. Values between 0.0 and 1.0 are permitted. A value of 1.0 generates shake positions anywhere within the boundaries of the image.

**Rotation Deviation**
This determines the amount of shake that is applied to the rotational axis. Values between 0.0 and 1.0 are permitted.

**Randomness**
Higher values in this control cause the movement of the shake to be more irregular or random. Smaller values cause the movement to be more predictable.

**Overall Strength**
This adjusts the general amplitude of all the parameters and blends that affect in and out. A value of 1.0 applies the effect as described by the remainder of the controls.

**Speed**
Speed controls the frequency, or rate, of the shake.

**Frequency Method**
This selects the overall shape of the shake. Available frequencies are Sine, Rectified Sine, and Square Wave. A Square Wave generates a much more mechanical-looking motion than a Sine.

**Filter Method**
When rescaling a pixel, surrounding pixels are often used to give a more realistic result. There are various algorithms for combining these pixels, called filters. More complex filters can give better results but are usually slower to calculate.
The best filter for the job often depends on the amount of scaling and on the contents of the image itself.

- **Box:** This is a simple interpolation resize of the image.
- **Linear:** This uses a simplistic filter, which produces relatively clean and fast results.
- **Quadratic:** This filter produces a nominal result. It offers a good compromise between speed and quality.
- **Cubic:** This produces better results with continuous-tone images. If the images have fine detail in them, the results may be blurrier than desired.
- **Catmull-Rom:** This produces good results with continuous-tone images that are resized down. This produces sharp results with finely detailed images.
- **Gaussian:** This is very similar in speed and quality to Bi-Cubic.
- **Mitchell:** This is similar to Catmull-Rom but produces better results with finely detailed images. It is slower than Catmull-Rom.
- **Lanczos:** This is very similar to Mitchell and Catmull-Rom but is a little cleaner and also slower.
- **Sinc:** This is an advanced filter that produces very sharp, detailed results; however, it may produce visible “ringing” in some situations.
- **Bessel:** This is similar to the Sinc filter but may be slightly faster.

**Window Method (Sinc and Bessel Only)**

Some filters, such as Sinc and Bessel, require an infinite number of pixels to calculate exactly. To speed up this operation, a windowing function is used to approximate the filter and limit the number of pixels required. This control appears when a filter that requires windowing is selected.

- **Hanning:** This is a simple tapered window.
- **Hamming:** Hamming is a slightly tweaked version of Hanning that does not taper all the way down to zero.
- **Blackman:** A window with a more sharply tapered falloff.
- **Kaiser:** A more complex window with results between Hamming and Blackman.

Most of these filters are useful only when making an image larger. When shrinking images, it is common to use the Bi-Linear filter, however, the Catmull-Rom filter will apply some sharpening to the results and may be useful for preserving detail when scaling down an image.

**Example**

![Resize filters. From left to right: Nearest Neighbor, Box, Linear, Quadratic, Cubic, Catmull-Rom, Gaussian, Mitchell, Lanczos, Sinc, and Bessel.](image)

**Edges**

This menu determines how the Edges of the image are treated.

- **Canvas:** This causes the edges that are revealed by the shake to be the canvas color—usually transparent or black.
- **Wrap:** This causes the edges to wrap around (the top is wrapped to the bottom, the left is wrapped to the right, and so on).
– **Duplicate:** This causes the Edges to be duplicated, causing a slight smearing effect at the edges.
– **Mirror:** Image pixels are mirrored to fill to the edge of the frame.

**Invert Transform**
Select this control to Invert any position, rotation, or scaling transformation. This option might be useful for exactly removing the motion produced in an upstream Camera Shake.

**Flatten Transform**
The Flatten Transform option prevents this node from concatenating its transformation with adjacent nodes. The node may still concatenate transforms from its input, but it will not concatenate its transformation with the node at its output.

**Common Controls**

**Settings Tab**
The Settings tab in the Inspector is also duplicated in other Transform nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.

---

### Crop [CRP]

The Crop node

---

### Crop Node Introduction

The Crop node can be used to cut out a portion of an image or to offset the image into a larger image area. However, unlike using a mask, this node actually changes the resolution of the image.

**TIP:** You can crop an image in the viewer by activating the Allow Box Selection in the upper-left corner of the viewer while the Crop node is selected and viewed. Then, drag a crop rectangle around the area of interest to perform the operation.

**NOTE:** Because this node changes the physical resolution of the image, animating the parameters is not advised.

---

### Inputs

The single input on the Crop node is used to connect a 2D image for cropping.

– **Input:** The orange input is used for the primary 2D image you want to crop.
Basic Node Setup

Below, the Crop node is inserted between the MediaIn1 node and the background input of the Merge. Unlike using a mask tool, cropping the MediaIn1 changes the resolution of the clip. The cropped MediaIn1 node connected to the orange background input also sets the resolution of the Merge output.

![Crop node setup diagram](image)

The Crop node can be used to cut out a portion of an image.

Inspector

The Crop Controls tab

Controls Tab

The Controls tab provides XY Offset and XY Size methods for cropping the image.

**Offset X and Y**
These controls position the image off the screen by pushing it left/right or up/down. The cropped image disappears off the edges of the output image. The values of these controls are measured in pixels.

**Size X and Y**
Use these controls to set the vertical and horizontal resolution of the image output by the Crop node. The values of these controls are measured in pixels.

**Keep Aspect**
When toggled on, the Crop node maintains the aspect of the input image.

**Keep Centered**
When toggled on, the Crop node automatically adjusts the X and Y Offset controls to keep the image centered. The XY Offset sliders are automatically adjusted, and control over the cropping is done with the Size sliders or the Allow Box Selection button in the viewer.
**Reset Size**
This resets the image dimensions to the size of the input image.

**Reset Offset**
This resets the X and Y Offsets to their defaults.

**Change Pixel Aspect**
Enable this checkbox to reveal a Pixel Aspect control that can be used to change the image's pixel aspect.

**Clipping Mode**
This option sets the mode used to handle the edges of the image when performing domain of definition (DoD) rendering. This is profoundly important for nodes like Blur, which may require samples from portions of the image outside the current domain.

- **Frame**: The default option is Frame, which automatically sets the node's domain of definition to use the full frame of the image, effectively ignoring the current domain of definition. If the upstream DoD is smaller than the frame, the remaining area in the frame will be treated as black/transparent.

- **Domain**: Setting this option to Domain will respect the upstream DoD when applying the node's effect. This can have adverse clipping effects in situations where the node employs a large filter.

- **None**: Setting this option to None does not perform any source image clipping at all. This means that any data required to process the node's effect that would normally be outside the upstream DoD is treated as black/transparent.

**Auto Crop Tab**
Auto Crop tab analyzes the selected channel and crops the image based on that channel's boundaries. The adjustments from auto crop are seen in the Crop tab parameters.

**RGBA Color Channels**
Select which channels are examined for an Auto Crop. This is useful for auto cropping images with non-solid backgrounds in a specific color channel, like a blue color gradient. Toggling the channel off causes Auto Crop to ignore it when evaluating the image.

**Auto Crop**
This evaluates the image and attempts to determine the background color. It then crops each side of the image to the first pixel that is not that color.

**Common Controls**

**Settings Tab**
The Settings tab in the Inspector is also duplicated in other Transform nodes. These common controls are described in detail at the end of this chapter in "The Common Controls" section.
DVE Node Introduction

The DVE (Digital Video Effects) node is a 3D-image transformation similar to nodes found in old, tape-based online editing suites. The node encompasses image rotations, perspective changes, and Z moves. The axis can be defined for all transformations.

Inputs

The three inputs on the DVE node are used to connect a 2D image, DVE mask, and an effect mask, which can be used to limit the DVE area.

- **Input:** The orange input is used for the primary 2D image that is transformed by the DVE.
- **DVE Mask:** The white DVE mask input is used to mask the image prior to the DVE transform being applied. This has the effect of modifying both the image and the mask.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input causes the DVE to modify only the image within the mask. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

In the example below, the DVE node is inserted between the MediaIn2 node and the foreground input of the Merge. The MediaIn1 node is manipulated in the DVE node and composited over the top of the MediaIn1 node.
Inspector

The DVE Controls tab

Controls Tab
The Controls tab includes all the transform parameters for the DVE.

Pivot X, Y, and Z
Positions the axis of rotation and scaling. The default is 0.5, 0.5 for X and Y, which is in the center of the image, and 0 for Z, which is at the center of Z space.

Rotation Order
Use these buttons to determine in what order rotations are applied to the image.

XYZ Rotation
These controls are used to rotate the image around the pivot along the X-, Y- and Z-axis.

Center X and Y
This positions the center of the DVE image onscreen. The default is 0.5, 0.5, which positions the DVE in the center of the image.

Z Move
This zooms the image in and out along the Z-axis. Visually, when this control is animated, the effect is similar to watching an object approach from a distance.

Perspective
This adds additional perspective to an image rotated along the X- or Y-axis, similar to changing the Field of View and zoom of a camera.

Masking Tab
The DVE node allows pre-masking of its input image. This offers the ability to create transformations from the masked area of the image while leaving the remainder of the image unaffected.
Unlike regular effect masks, the masking process occurs before the transformation. All the usual mask types can be applied to the DVE mask.

**Black Background**
Toggle this on to erase the area outside the mask from the transformed image.

**Fill Black**
Toggle this on to erase the area within the mask (before transformation) from the DVE’s input, effectively cutting the masked area out of the image. Enabling both Black Background and Fill Black will show only the masked, transformed area.

**Alpha Mode**
This determines how the DVE will handle the alpha channel of the image when merging the transformed image areas over the untransformed image.

- **Ignore Alpha**: This causes the input image’s alpha channel to be ignored, so all masked areas will be opaque.

- **Subtractive/Additive**: These cause the internal merge of the pre-masked DVE image over the input image to be either Subtractive or Additive.

  - An Additive setting is necessary when the foreground DVE image is premultiplied, meaning that the pixels in the color channels have been multiplied by the pixels in the alpha channel. The result is that transparent pixels are always black, since any number multiplied by 0 always equals 0. This obscures the background (by multiplying with the inverse of the foreground alpha), and then simply adds the pixels from the foreground.

  - A Subtractive setting is necessary if the foreground DVE image is not premultiplied. The compositing method is similar to an Additive merge, but the foreground DVE image is first multiplied by its own alpha, to eliminate any background pixels outside the alpha area.

**Common Controls**

**Settings Tab**
The Settings tab in the Inspector is also duplicated in other Transform nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

**Letterbox [LBX]**

The Letterbox node

**Letterbox Node Introduction**
Use the Letterbox node to adapt existing images to the frame size and aspect ratios of any other format. The most common use of this node is to convert film resolution images to HD-sized frames for viewing on an external television monitor. Horizontal or vertical black edges are automatically added where necessary to compensate for aspect ratio differences. This node actually changes the resolution of the image.
NOTE: Because this node changes the physical resolution of the image, animating the controls is not recommended.

Inputs
The single input on the Letterbox node is used to connect a 2D image for letterbox/cropping.

- **Input:** The orange input is used for the primary 2D image you want to letterbox/crop.

Basic Node Setup
The Letterbox node is used in the example below to change the resolution of the Merge node’s output. Depending on how the resolution is modified, side pillars, or a horizontal letterbox mask, is applied to “fill in” the frame area, which the Merge node output does not cover.

![The Letterbox node converting the Merge output resolution and adding letterbox masking where needed.](image)

Inspector
The Letterbox Controls tab

Controls Tab
The Controls tab includes parameters for adjusting the resolution and pixel aspect of the image. It also has the option of letterboxing or pan-and-scan formatting.

**Width and Height**
The values of these controls determine the size of the output image as measured in pixels.

**TIP:** You can use the formatting contextual menu to quickly select a resolution from a list. Place the pointer over the Width or Height controls, and then right-click to display the contextual menu. The bottom of the menu displays a Select Frame Format submenu with available frame formats. Select any one of the choices from the menu to set the Height, Width, and Aspect controls automatically.
Auto Resolution
Activating this checkbox automatically sets the Width and Height sliders to the Frame Format settings found in the Preferences window for Fusion Studio or to the resolution of the DaVinci Resolve Timeline.

Pixel Aspect X and Y
These controls determine the pixel aspect ratio of the output image.

Center X and Y
This Center control repositions the image window when used in conjunction with Pan-and-Scan mode. It has no effect on the image when the node is set to Letterbox mode.

Mode
This control is used to determine the Letterbox node’s mode of operation.

– **Letterbox/Envelope**: This corrects the aspect of the input image and resizes it to match the specified width.
– **Pan-and-Scan**: This corrects the aspect of the input image and resizes it to match the specified height. If the resized input image is wider than the specified width, the Center control can be used to animate the visible portion of the resized input.

Filter Method
When rescaling a pixel, surrounding pixels are often used to give a more realistic result. There are various algorithms for combining these pixels, called filters. More complex filters can give better results but are usually slower to calculate. The best filter for the job often depends on the amount of scaling and on the contents of the image itself.

– **Box**: This is a simple interpolation resize of the image.
– **Linear**: This uses a simplistic filter, which produces relatively clean and fast results.
– **Quadratic**: This filter produces a nominal result. It offers a good compromise between speed and quality.
– **Cubic**: This produces better results with continuous-tone images. If the images have fine detail in them, the results may be blurrier than desired.
– **Catmull-Rom**: This produces good results with continuous-tone images that are resized down. This produces sharp results with finely detailed images.
– **Gaussian**: This is very similar in speed and quality to Bi-Cubic.
– **Mitchell**: This is similar to Catmull-Rom but produces better results with finely detailed images. It is slower than Catmull-Rom.
– **Lanczos**: This is very similar to Mitchell and Catmull-Rom but is a little cleaner and also slower.
– **Sinc**: This is an advanced filter that produces very sharp, detailed results; however, it may produce visible “ringing” in some situations.
– **Bessel**: This is similar to the Sinc filter but may be slightly faster.

Window Method (Sinc and Bessel Only)
Some filters, such as Sinc and Bessel, require an infinite number of pixels to calculate exactly. To speed up this operation, a windowing function is used to approximate the filter and limit the number of pixels required. This control appears when a filter that requires windowing is selected.

– **Hanning**: This is a simple tapered window.
– **Hamming**: Hamming is a slightly tweaked version of Hanning that does not taper all the way down to zero.
– **Blackman**: A window with a more sharply tapered falloff.
– **Kaiser**: A more complex window with results between Hamming and Blackman.

Most of these filters are useful only when making an image larger. When shrinking images, it is common to use the Bi-Linear filter; however, the Catmull-Rom filter will apply some sharpening to the results and may be useful for preserving detail when scaling down an image.

**Example**

Different resize filters. From left to right: Nearest Neighbor, Box, Linear, Quadratic, Cubic, Catmull-Rom, Gaussian, Mitchell, Lanczos, Sinc, and Bessel.

**Common Controls**

**Settings Tab**
The Settings tab in the Inspector is also duplicated in other Transform nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

**Resize [RSZ]**

The Resize node

**Resize Node Introduction**

Use the Resize node to increase or decrease the resolution of an input image. This is useful for converting images from one format to another (for example, from film to video resolution). This node actually changes the resolution of the image.

**NOTE**: Because this node changes the physical resolution of the image, animating the controls is not advised.

**Inputs**
The single input on the Resize node is used to connect a 2D image for resizing.

– **Input**: The orange input is used for the primary 2D image you want to resize.
Basic Node Setup

Below, the Resize node is inserted between the MediaIn1 node and the background input of the Merge. Unlike using a Transform tool, resizing the MediaIn1 changes the resolution of the clip. The resized MediaIn1 node connected to the orange background input also sets the resolution of the Merge output.

![Diagram](image)

The Resize node can be used to scale an image and change its resolution.

Inspector

![Inspector](image)

The Resize Controls tab

Controls Tab

The Controls tab includes parameters for changing the resolution of the image. It uses pixel values in the Width and Height controls.

**Width**

This controls the new resolution for the image along the X-axis.

**Height**

This controls the new resolution for the image along the Y-axis.

**Tip:** You can use the formatting contextual menu to quickly select a resolution from a list. Place the mouse pointer over the Width or Height controls, and then right-click to display the contextual menu. The bottom of the menu displays a Select Frame Format submenu with available frame formats. Select any one of the choices from the menu to set the Height and Width controls automatically.

Auto Resolution

Activating this checkbox automatically sets the Width and Height sliders to the Frame Format settings found in the Preferences window for Fusion Studio or the resolution in the DaVinci Resolve Timeline.
Reset Size
Reset the image dimensions to the original size of the image.

Keep Frame Aspect
When toggled on, the Resize node maintains the aspect of the original image, preserving the original ratio between width and height.

Only Use Filter in HiQ
The Resize node will normally use the fast Nearest Neighbor filter for any non-HiQ renders, where speed is more important than full accuracy. Disable this checkbox to force Resize to always use the selected filter for all renders.

Change Pixel Aspect
Enable this checkbox to reveal a Pixel Aspect control that can be used to change the image’s pixel aspect.

Filter Method
When rescaling a pixel, surrounding pixels are often used to give a more realistic result. There are various algorithms for combining these pixels, called filters. More complex filters can give better results but are usually slower to calculate. The best filter for the job often depends on the amount of scaling and on the contents of the image itself.

- **Box**: This is a simple interpolation resize of the image.
- **Linear**: This uses a simplistic filter, which produces relatively clean and fast results.
- **Quadratic**: This filter produces a nominal result. It offers a good compromise between speed and quality.
- **Cubic**: This produces better results with continuous-tone images. If the images have fine detail in them, the results may be blurrier than desired.
- **Catmull-Rom**: This produces good results with continuous-tone images that are resized down. This produces sharp results with finely detailed images.
- **Gaussian**: This is very similar in speed and quality to Bi-Cubic.
- **Mitchell**: This is similar to Catmull-Rom but produces better results with finely detailed images. It is slower than Catmull-Rom.
- **Lanczos**: This is very similar to Mitchell and Catmull-Rom but is a little cleaner and also slower.
- **Sinc**: This is an advanced filter that produces very sharp, detailed results; however, it may produce visible “ringing” in some situations.
- **Bessel**: This is similar to the Sinc filter but may be slightly faster.

Window Method (Sinc and Bessel Only)
Some filters, such as Sinc and Bessel, require an infinite number of pixels to calculate exactly. To speed up this operation, a windowing function is used to approximate the filter and limit the number of pixels required. This control appears when a filter that requires windowing is selected.

- **Hanning**: This is a simple tapered window.
- **Hamming**: Hamming is a slightly tweaked version of Hanning that does not taper all the way down to zero.
- **Blackman**: A window with a more sharply tapered falloff.
- **Kaiser**: A more complex window with results between Hamming and Blackman.
Most of these filters are useful only when making an image larger. When shrinking images, it is common to use the Bi-Linear filter; however, the Catmull-Rom filter will apply some sharpening to the results and may be useful for preserving detail when scaling down an image.

Example

Different resize filters. From left to right: Nearest Neighbor, Box, Linear, Quadratic, Cubic, Catmull-Rom, Gaussian, Mitchell, Lanczos, Sinc, and Bessel.

Common Controls

Settings Tab

The Settings tab in the Inspector is also duplicated in other Transform nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Scale [SCL]

The Scale node

Scale Node Introduction

The Scale node is almost identical to the Resize node, except that Resize uses exact dimensions, whereas the Scale node uses relative dimensions to describe the change to the source image’s resolution. This node actually changes the resolution of the image.

NOTE: Because this node changes the physical resolution of the image, animating the controls is not advised.

Inputs

The single input on the Scale node is used to connect a 2D image for scaling.

- **Input:** The orange input is used for the primary 2D image you want to scale.

Basic Node Setup

Below, the Scale node is inserted between the MediaIn1 node and the background input of the Merge. Unlike using a Transform tool, scaling the MediaIn1 changes the resolution of the clip. The resized MediaIn1 node connected to the orange background input also sets the resolution of the Merge output.
The Scale node can be used to scale an image and change its resolution.

**Inspector**

The Scale Controls tab

**Controls Tab**
The Controls tab includes parameters for changing the resolution of the image. It uses a multiplier of size to set the new resolution. An Edges menu allows you to determine how the edges of the frame are handled if the scaling decreases.

**Lock X/Y**
When selected, only a Size control is shown, and changes to the image’s scale are applied to both axes equally. If the checkbox is cleared, individual Size controls appear for both X and Y Size.

**Size**
The Size control is used to set the scale used to adjust the resolution of the source image. A value of 1.0 would have no affect on the image, while 2.0 would scale the image to twice its current resolution. A value of 0.5 would halve the image’s resolution.

**Only Use Filter in HiQ**
The Scale node will normally use the fast Nearest Neighbor filter for any non-HiQ renders, where speed is more important than full accuracy. Disable this checkbox to force Scale to always use the selected filter for all renders.

**Change Pixel Aspect**
Enable this checkbox to reveal a Pixel Aspect control that can be used to change the image’s pixel aspect.

**Filter Method**
When rescaling a pixel, surrounding pixels are often used to give a more realistic result. There are various algorithms for combining these pixels, called filters. More complex filters can give better
results but are usually slower to calculate. The best filter for the job often depends on the amount of scaling and on the contents of the image itself.

- **Box**: This is a simple interpolation resize of the image.
- **Linear**: This uses a simplistic filter, which produces relatively clean and fast results.
- **Quadratic**: This filter produces a nominal result. It offers a good compromise between speed and quality.
- **Cubic**: This produces better results with continuous-tone images. If the images have fine detail in them, the results may be blurrier than desired.
- **Catmull-Rom**: This produces good results with continuous-tone images that are resized down. This produces sharp results with finely detailed images.
- **Gaussian**: This is very similar in speed and quality to Bi-Cubic.
- **Mitchell**: This is similar to Catmull-Rom but produces better results with finely detailed images. It is slower than Catmull-Rom.
- **Lanczos**: This is very similar to Mitchell and Catmull-Rom but is a little cleaner and also slower.
- **Sinc**: This is an advanced filter that produces very sharp, detailed results; however, it may produce visible “ringing” in some situations.
- **Bessel**: This is similar to the Sinc filter but may be slightly faster.

**Window Method (Sinc and Bessel Only)**

Some filters, such as Sinc and Bessel, require an infinite number of pixels to calculate exactly. To speed up this operation, a windowing function is used to approximate the filter and limit the number of pixels required. This control appears when a filter that requires windowing is selected.

- **Hanning**: This is a simple tapered window.
- **Hamming**: Hamming is a slightly tweaked version of Hanning that does not taper all the way down to zero.
- **Blackman**: A window with a more sharply tapered falloff.
- **Kaiser**: A more complex window with results between Hamming and Blackman.

Most of these filters are useful only when making an image larger. When shrinking images, it is common to use the Bi-Linear filter; however, the Catmull-Rom filter will apply some sharpening to the results and may be useful for preserving detail when scaling down an image.

**NOTE**: Because this node changes the physical resolution of the image, animating the controls is not advised.

**Example**

Different resize filters. From left to right: Nearest Neighbor, Box, Linear, Quadratic, Cubic, Catmull-Rom, Gaussian, Mitchell, Lanczos, Sinc, and Bessel.
Transform [XF]

The Transform node

Transform Node Introduction

The Transform node can be used for simple 2D transformations of the image, such as moving, rotating, and scaling. The image’s aspect can also be modified using the Transform node.

The Transform node concatenates its result with adjacent Transformation nodes. The Transform node does not change the image’s resolution.

Inputs

The two inputs on the Transform node are used to connect a 2D image and an effect mask, which can be used to limit the transformed area.

- **Input:** The orange input is used for the primary 2D image that gets transformed.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the transform area to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

The Transform node in the example below is inserted between the MediaIn2 node and the foreground input of the Merge. Unlike using a Scale or Resize tool, transforming the MediaIn2 does not change the resolution of the clip. For that reason, it is the tool most often used to scale, move, and rotate a clip.

The Transform node can be used to scale an image without changing its resolution.
Inspector

The Transform Controls tab

Controls Tab
The Controls tab presents multiple ways to transform, flip (vertical), flop (horizontal), scale, and rotate an image. It also includes reference size controls that can reinterpret the coordinates used for width and height from relative values of 0-1 into pixel values based on the image's resolution.

Center X and Y
This sets the position of the image on the screen. The default is 0.5, 0.5, which places the image in the center of the screen. The value shown is always the actual position multiplied by the reference size. See below for a description of the reference size.

Pivot X and Y
This positions the axis of rotation and scaling. The default is 0.5, 0.5, which is the center of the image.

Use Size and Aspect
This checkbox determines whether the Transform node provides independent Size controls for the X and Y scale or if Size and Aspect controls are used instead.

Size
This modifies the scale of the image. Values range from 0 to 5, but any value greater than zero can be entered into the edit box. If the Use Size and Aspect checkbox is selected, this control will scale the image equally along both axes. If the Use Size and Aspect option is off, independent control is provided for X and Y.

Aspect
This control changes the aspect ratio of an image. Setting the value above 1.0 stretches the image along the X-axis. Values between 0.0 and 1.0 stretch the image along the Y-axis. This control is available only when the Use Size and Aspect checkbox is enabled.

Angle
This control rotates the image around the axis. Increasing the Angle rotates the image in a counterclockwise direction. Decreasing the Angle rotates the image in a clockwise direction.
Flip Horizontally and Vertically
Toggle this control on to flip the image along the X- or Y-axis.

Edges
This menu determines how the edges of the image are treated when the edge of the raster is exposed.

– **Canvas**: This causes the edges of the image that are revealed to show the current Canvas Color. This defaults to black with no Alpha and can be set using the Set Canvas Color node.

– **Wrap**: This wraps the edges of the image around the borders of the image. This is useful for seamless images to be panned, creating an endless moving background image.

– **Duplicate**: This causes the edges of the image to be duplicated as best as possible, continuing the image beyond its original size.

– **Mirror**: Image pixels are mirrored to fill to the edge of the frame.

Filter Method
When rescaling a pixel, surrounding pixels are often used to give a more realistic result. There are various algorithms for combining these pixels, called filters. More complex filters can give better results but are usually slower to calculate. The best filter for the job often depends on the amount of scaling and on the contents of the image itself.

– **Box**: This is a simple interpolation resize of the image.

– **Linear**: This uses a simplistic filter, which produces relatively clean and fast results.

– **Quadratic**: This filter produces a nominal result. It offers a good compromise between speed and quality.

– **Cubic**: This produces better results with continuous-tone images. If the images have fine detail in them, the results may be blurrier than desired.

– **Catmull-Rom**: This produces good results with continuous-tone images that are resized down. This produces sharp results with finely detailed images.

– **Gaussian**: This is very similar in speed and quality to Bi-Cubic.

– **Mitchell**: This is similar to Catmull-Rom but produces better results with finely detailed images. It is slower than Catmull-Rom.

– **Lanczos**: This is very similar to Mitchell and Catmull-Rom but is a little cleaner and also slower.

– **Sinc**: This is an advanced filter that produces very sharp, detailed results; however, it may produce visible “ringing” in some situations.

– **Bessel**: This is similar to the Sinc filter but may be slightly faster.

Window Method (Sinc and Bessel Only)
Some filters, such as Sinc and Bessel, require an infinite number of pixels to calculate exactly. To speed up this operation, a windowing function is used to approximate the filter and limit the number of pixels required. This control appears when a filter that requires windowing is selected.

– **Hanning**: This is a simple tapered window.

– **Hamming**: Hamming is a slightly tweaked version of Hanning that does not taper all the way down to zero.

– **Blackman**: A window with a more sharply tapered falloff.

– **Kaiser**: A more complex window with results between Hamming and Blackman.
Most of these filters are useful only when making an image larger. When shrinking images, it is common to use the Bi-Linear filter; however, the Catmull-Rom filter will apply some sharpening to the results and may be useful for preserving detail when scaling down an image.

**Example**

![Different resize filters. From left to right: Nearest Neighbor, Box, Linear, Quadratic, Cubic, Catmull-Rom, Gaussian, Mitchell, Lanczos, Sinc, and Bessel.](image)

**Invert Transform**

Select this control to invert any position, rotation, or scaling transformation. This option is useful when connecting the Transform to the position of a tracker for the purpose of reintroducing motion back into a stabilized image.

**Flatten Transform**

The Flatten Transform option prevents this node from concatenating its transformation with adjacent nodes. The node may still concatenate transforms from its input, but it will not concatenate its transformation with the node at its output.

**Reference Size**

The controls under the Reference Size menu do not directly affect the image. Instead they allow you to control how Fusion represents the position of the Transform node’s center.

Normally, coordinates are represented as values between 0 and 1, where 1 is a distance equal to the full width or height of the image. This allows for resolution independence, because you can change the size of the image without having to change the value of the center.

One disadvantage to this approach is that it complicates making pixel-accurate adjustments to an image. To demonstrate, imagine an image that is 100 x 100 pixels in size. To move the center of the image to the right by 5 pixels, we would change the X value of the transform center from 0.5, 0.5 to 0.55, 0.5. We know the change must be 0.05 because 5/100 = 0.05.

The Reference Size controls allow you to specify the dimensions of the image. This changes the way the control values are displayed, so that the Center shows the actual pixel positions in the X and Y number fields of the Center control. Extending our example, if you set the Width and Height to 100 each, the Center would now be shown as 50, 50, and we would move it 5 pixels toward the right by entering 55, 50.

Internally, the Transform node still stores this value as a number between 0 to 1, and if you were to query the Center controls value via scripting, or publish the Center control for use by other nodes, then you would retrieve the original normalized value. The change is visible only in the value shown for Transform Center in the node control.

**Reference Width and Height Sliders**

Set these to the width and height of the image to change the way that Fusion displays the values of the Transform node’s Center control.

**Auto Resolution**

Enable this checkbox to use the current frame format settings in Fusion Studio or the timeline resolution in DaVinci Resolve to set the Reference Width and Reference Height values.
The Common Controls

Nodes that handle Transform operations share several identical controls in the Inspector. This section describes controls that are common among Transform nodes.

Inspector

Settings Tab

The Settings tab in the Inspector can be found on every tool in the Transform category. The Settings controls are even found on third-party Transform-type plug-in tools. The controls are consistent and work the same way for each tool.

Blend

The Blend control is used to blend between the tool’s original image input and the tool’s final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming image. Normally, this will cause the tool to skip processing entirely, copying the input straight to the output.

Process When Blend Is 0.0

The tool is processed even when the input value is zero. This can be useful if the node is scripted to trigger a task, but the node’s value is set to 0.0.
**Red/Green/Blue/Alpha Channel Selector**

These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.

For example, if the Red button on a Blur tool is deselected, the blur will first be applied to the image, and then the red channel from the original input will be copied back over the red channel of the result.

There are some exceptions, such as tools for which deselecting these channels causes the tool to skip processing that channel entirely. Tools that do this will generally possess a set of identical RGBA buttons on the Controls tab in the tool. In this case, the buttons in the Settings and the Controls tabs are identical.

**Apply Mask Inverted**

Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

**Multiply by Mask**

Selecting this option will cause the RGB values of the masked image to be multiplied by the mask channel’s values. This will cause all pixels of the image not included in the mask (i.e., set to 0) to become black/transparent.

**Use Object/Use Material (Checkboxes)**

Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports Object ID and Material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels will be used, if present. The specific Material ID or Object ID affected is chosen using the next set of controls.

**Correct Edges**

This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option is disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information on the Coverage and Background Color channels, see Chapter 18, “Understanding Image Channels” in the Fusion Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.

**Object ID/Material ID (Sliders)**

Use these sliders to select which ID will be used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker: to grab IDs from the image displayed in the viewer. The image or sequence must have been rendered from a 3D software package with those channels included.

**Motion Blur**

- **Motion Blur:** This toggles the rendering of Motion Blur on the tool. When this control is toggled on, the tool’s predicted motion is used to produce the motion blur caused by the virtual camera’s shutter. When the control is toggled off, no motion blur is created.

- **Quality:** Quality determines the number of samples used to create the blur. A quality setting of 2 will cause Fusion to create two samples to either side of an object’s actual motion. Larger values produce smoother results but increase the render time.

- **Shutter Angle:** Shutter Angle controls the angle of the virtual shutter used to produce the motion blur effect. Larger angles create more blur but increase the render times. A value of 360 is the equivalent of having the shutter open for one full frame exposure. Higher values are possible and can be used to create interesting effects.
– **Center Bias**: Center Bias modifies the position of the center of the motion blur. This allows for the creation of motion trail effects.

– **Sample Spread**: Adjusting this control modifies the weighting given to each sample. This affects the brightness of the samples.

**Use GPU**

The Use GPU menu has three settings. Setting the menu to Disable turns off GPU hardware-accelerated rendering. Enabled uses the GPU hardware for rendering the node. Auto uses a capable GPU if one is available and falls back to software rendering when a capable GPU is not available.

**Hide Incoming Connections**

Enabling this checkbox can hide connection lines from incoming nodes, making a node tree appear cleaner and easier to read. When enabled, empty fields for each input on a node will be displayed in the Inspector. Dragging a connected node from the node tree into the field will hide that incoming connection line as long as the node is not selected in the node tree. When the node is selected in the node tree, the line will reappear.

**Comments**

The Comments field is used to add notes to a tool. Click in the empty field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

**Scripts**

Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
This chapter details the Virtual Reality (VR) nodes available in Fusion.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

<table>
<thead>
<tr>
<th>VR Nodes</th>
<th>2412</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lat Long Patcher [LLP]</td>
<td>2413</td>
</tr>
<tr>
<td>Pano Map [PaM]</td>
<td>2414</td>
</tr>
<tr>
<td>Spherical Camera [3SC]</td>
<td>2416</td>
</tr>
<tr>
<td>Spherical Stabilizer</td>
<td>2417</td>
</tr>
<tr>
<td>The Common Controls</td>
<td>2419</td>
</tr>
</tbody>
</table>
VR Nodes

You can create and fix spherical (360°) video, often described as Virtual Reality, or VR, using Fusion’s set of VR nodes. Dome productions, planetariums, and other special-venue theaters have utilized the flexibility of Fusion and its 3D system to produce and deliver special content for years.

The equirectangular (lat-long) format often used for 360° video is similar to how a globe is represented by a flat world map, with the poles at the top and bottom edges of the image and the forward viewpoint at the center.

**TIP:** You can create stereo VR using two stacked Lat Long images, one for each eye.

Fusion supports several common spherical image formats and can easily convert between them.

- **VCross and HCross:** VCross and HCross are the six square faces of a cube laid out in a cross, vertically or horizontally, with the forward view in the center of the cross in a 3:4 or 4:3 image.

- **VStrip and HStrip:** VStrip and HStrip are the six square faces of a cube laid vertically or horizontally in a line, ordered as Left, Right, Up, Down, Back, Front (+X, -X, +Y, -Y, +Z, -Z) in a 1:6 or 6:1 image.

- **LatLong:** LatLong is a single 2:1 image in an equirectangular mapping.

You can display both spherical video and live 3D scenes from the comp directly to headsets, including those from Oculus Rift and HTC Vive.

Fusion’s “Fix it in post” tools for VR make it easy to perform several important tasks that are common in these types of productions.
Lat Long Patcher [LLP]

The Lat Long Patcher node

NOTE: The VR category and Lat Long node are available only in Fusion Studio and DaVinci Resolve Studio.

Lat Long Patcher Node Introduction

Equirectangular stitched images often need patches, paintwork, or other VFX applied. The Lat Long Patcher extracts and de-warp a section of a lat-long (equirectangular) image to be treated, and can warp and merge fixes back over the original. You can quickly pick a section of the spherical image to patch or paint, and then apply it back to the original image. Note that matching rotations are used in both Extract and Apply modes, allowing a node’s operation to be easily reversed by a copy or instance with the same rotation settings.

Input

The Lat Long Patcher node includes two inputs. The orange input accepts a 2D image in an equirectangular format, where the X-axis represents 0–360 degrees longitude, and the Y-axis represents −90 to +90 degrees latitude. The effect mask input is provided, although rarely used on VR nodes.

- **Image Input**: The orange image input accepts a equirectangular (lat-long) 2D RGBA image.
- **Effect Mask**: The effect mask input is provided, although rarely used on VR nodes.

Basic Node Setup

The Loader node connects to the input on a Lat Long Patcher node. The output of a Lat Long Patcher node is set to Extract. It is then connected to whatever image-processing operation is required. A second Lat Long Patcher node set to Apply takes an input from the processed extraction and merges it over the top of the original source.

Two Lat Long Patchers used to repair a section
Inspector

The Controls tab is used to extract and later reapply a section from an equirectangular image. Rotation controls allow you to select the exact portion you need to repair.

**Mode**
- **Extract**: Pulls a de-warped 90-degree square image from the equirectangular image.
- **Apply**: Warps and merges a 90-degree square image over the equirectangular image. Because the square image’s alpha is used, this allows, for example, paint strokes or text drawn over a transparent black background to be applied to the original equirectangular image, avoiding any double-filtering from de-warping and re-warping the original.

**Rotation Order**
These buttons choose the ordering of the rotations around each axis. For example, XYZ rotates first around the X axis (pitch/tilt), then around the Y axis (pan/yaw), and then around the Z axis (roll). Any of the six possible orderings can be chosen.

**Rotation**
These dials rotate the spherical image around each of the X, Y, and Z axes, offering independent control over pitch/tilt, pan/yaw, and roll, respectively.

Common Controls

Settings Tab
The Settings tab in the Inspector is duplicated in other VR nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Pano Map [PaM]

**NOTE**: The VR category and Pano Map node are available only in Fusion Studio and DaVinci Resolve Studio.
Pano Map Node Introduction

The Pano Map node converts images from one spherical layout to another, such as from a cube map to an equirectangular format. The node can also perform rotations of the spherical images when converting.

Input

The Pano Map node includes two inputs. The orange input accepts a 2D image in an equirectangular, cube map or other spherical formats. The effect mask input is provided, although rarely used on VR nodes.

- **Image Input:** The orange Image input accepts a spherical formatted 2D RGBA image that gets converted to another spherical format.
- **Effect Mask:** The effect mask input is provided, although rarely used on VR nodes.

Basic Node Setup

In the example below, a Loader node containing a Lat Long image connects to the input on a Pano Map node. The Pano Map node is used to convert the image to an H-Cross format. It is then connected to whatever image-processing operation is required.

A Pano Map used to convert from one VR format to another

Inspector

The Pano Map Controls tab

**Controls Tab**

The Controls tab is used to determine the format of the input image and the desired output format.

**From/To**

- **Auto:** Auto detects the incoming image layout from the metadata and image frame aspect.
- **VCross and HCross:** VCross and HCross are the six square faces of a cube laid out in a cross, vertically or horizontally, with the forward view in the center of the cross in a 3:4 or 4:3 image.
– **VStrip and HStrip:** VStrip and HStrip are the six square faces of a cube laid vertically or horizontally in a line, ordered as Left, Right, Up, Down, Back, Front (+X, -X, +Y, -Y, +Z, -Z) in a 1:6 or 6:1 image.

– **LatLong:** LatLong is a single 2:1 image in equirectangular mapping.

**Rotation Order**

These buttons choose the ordering of the rotations around each axis. For example, XYZ rotates first around the X axis (pitch/tilt), then around the Y axis (pan/yaw), and then around the Z axis (roll). Any of the six possible orderings can be chosen.

**Rotation**

These dials rotate the spherical image around each of the X, Y, and Z axes, offering independent control over pitch/tilt, pan/yaw, and roll, respectively.

**Common Controls**

**Settings Tab**

The Settings tab in the Inspector is duplicated in other VR nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

---

**Spherical Camera [3SC]**

The Spherical Camera node

---

**Spherical Camera Node Introduction**

The Spherical Camera is not located in the VR category of the Effects Library but in the 3D category. However, it is commonly used in creating and fixing VR content, so it is referenced here. The Spherical Camera allows the 3D Renderer node to output an image covering all viewing angles, laid out in several different formats. This image may be used, for example, as a skybox texture or reflection map or viewed in a VR headset. The Image Width setting in the 3D Renderer sets the size of each square cube face so that the resulting image may be a multiple of this size horizontally and vertically.

Spherical Stabilizer

The Spherical Stabilizer node

**NOTE:** The VR category and Spherical Stabilizer node are available only in Fusion Studio and DaVinci Resolve Studio.

### Spherical Stabilizer Node Introduction

VR live action often uses handheld cameras, causing shaky footage to be a common problem. The Spherical Stabilizer node automatically identifies and tracks visible features in the footage, and then analyzes their movement to identify pan, tilt, and roll rotations. After tracking, it is then possible to smooth out or stabilize the rotation of the footage.

### Inputs

The Spherical Stabilizer node has a single orange input.

- **Image:** This orange image input node requires an image in a spherical layout, which can be any of Lat Long (2:1 equirectangular), Horizontal/Vertical Cross, or Horizontal/Vertical Strip.

### Basic Node Setup

In the example below, a 2:1 Lat Long image is connected to the input of the Spherical Stabilizer node. Once the image is stabilized, the output of the Spherical Stabilizer node is a steadied clip.

Spherical Stabilizer set up to steady a 2.1 Lat Long clip
Inspector

The Spherical Stabilizer Controls tab

Controls Tab
The Controls tab contains parameters to initiate the tracking and modify the results for stabilization or smoothing.

Reject Dominant Motion Outliers While Tracking
With this control activated (the default setting), features that move contrary to the majority of other features are ignored. This helps ignore the movement of subjects in the shot, preferring stable and consistent markers from the surrounding environment.

Track Controls
These buttons initiate tracking and analysis of the shot. Be aware that the reference frame used for stabilization is set to the first frame tracked.
- Track Backward from End Frame starts tracking backward from the end of the current render range.
- Track Backward from Current Time starts tracking backward from the current frame.
- Stop ceases tracking, preserving all results so far.
- Track Forward from Current Time starts tracking forward from the start of the current render range.
- Track Forward from Start Frame starts tracking forward from the current time.

Append to Track
- Replace causes the Track Controls to discard any previous tracking results and replace them with the newly-created track.
- Append adds the new tracking results to any earlier tracks.

Stabilization Strength
This control varies the amount of smoothing or stabilization applied, from 0.0 (no change) to 1.0 (maximum).

Smoothing
The Spherical Stabilizer node can eliminate all rotation from a shot, fixing the forward viewpoint (Still mode, 0.0) or gently smooth out any panning, rolling, or tilting to increase viewer comfort (Smooth mode, 1.0). This slider allows either option or anything in between.
Offset Rotation

Often a shot is not entirely level and needs the horizon to be realigned, or perhaps a desired pan should be reintroduced after fully stabilizing the shot. The Offset Rotation controls allow additional manual control of the Spherical Stabilizer’s rotation of the footage, for pitch/tilt (X), pan/yaw (Y), and roll (Z), respectively. Rotation is always performed in the order X, Y, Z.

Common Controls

Settings Tab

The Settings tab in the Inspector is duplicated in other VR nodes. These common controls are described in detail in the following “The Common Controls” section.

The Common Controls

Nodes that handle VR operations share a number of identical controls in the Inspector. This section describes controls that are common among VR nodes.

Inspector

The VR Common controls

Settings Tab

The Settings tab in the Inspector can be found on every tool in the VR category. The controls are consistent and work the same way for each tool.

Apply Mask Inverted

Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.
Use GPU
The Use GPU menu has three settings. Setting the menu to Disable turns off hardware-accelerated rendering using the graphics card in your computer. Auto uses a capable GPU if one is available and falls back to software rendering when a capable GPU is not available.

Hide Incoming Connections
Enabling this checkbox can hide connection lines from incoming nodes, making a node tree appear cleaner and easier to read. When enabled, empty fields for each input on a node are displayed in the Inspector. Dragging a connected node from the node tree into the empty field hides that incoming connection line as long as the node is not selected in the node tree. When the node is selected in the node tree, the line reappears.

Comments
The Comments field is used to add notes to a tool. Click in the empty field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

Scripts
Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
Chapter 121

Warp Nodes

This chapter details the Warp nodes available in Fusion.

The abbreviations next to each node name can be used in the Select Tool dialog when searching for tools and in scripting references.

For purposes of this document, node trees showing MediaIn nodes in DaVinci Resolve are interchangeable with Loader nodes in Fusion Studio, unless otherwise noted.

Contents

Coordinate Space [CDS] 2422
Corner Positioner [CPN] 2423
Dent [DNT] 2425
Displace [DSP] 2427
Drip [DRP] 2429
Grid Warp [GRD] 2431
Lens Distort [LENS] 2438
Perspective Positioner [PPN] 2440
Vector Distortion [DST] 2442
Vortex [VTX] 2444
The Common Controls 2446
Coordinate Space Node Introduction

The Coordinate Space node changes the coordinate space of the image from rectangular to polar or from polar to rectangular.

Inputs

The two inputs on the Coordinate Space node are used to connect a 2D image and an effect mask, which can be used to limit the distorted area.

- **Input**: The orange input is used for the primary 2D image that is distorted.
- **Effect Mask**: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the distortion to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

The Coordinate Space node is used below to make a circular pattern based on a Fast Noise, Mosaic Blur (DaVinci Resolve Resolve FX only), and a Transform node. The Crop node at the end is used to set the desired resolution.

Example

To demonstrate a basic tunnel effect that can be achieved with this node:

1. Add a Text+ node with some text, and then animate it to move along a path from the top of the frame to the bottom.
2. Connect the output of the Text+ node to a Coordinate Space node.
3. Select Polar to Rectangular from the Shape menu.
As the text moves from top to bottom along the original path, it appears to move from an infinite distance in the Coordinate Space node. It may be necessary to flip the text using a Transform node to make it appear the correct way in the Coordinate Space node. Another common use for the Coordinate Space node is to use it in pairs: two of them set to different Shape settings with a Drip or Transform node in between. When used in this way, the effect gets modified while the image remains the same.

Inspector

The Coordinate Space Controls tab

Controls Tab

The Controls tab Shape menu switches between Rectangular to Polar and Polar to Rectangular. Consider the following example to demonstrate the two coordinate spaces.

Common Controls

Settings Tab

The Settings tab in the Inspector is also duplicated in other Warp nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Corner Positioner [CPN]

The Corner Positioner node

Corner Positioner Node Introduction

The Corner Positioner can be used to position the four corners of an image interactively. This would typically be used to replace a sign or other rectangular portion of a scene. Connect all corners to Paths or Trackers for animation purposes.

Inputs

The two inputs on the Corner Positioner node are used to connect a 2D image and an effect mask, which can be used to limit the warped area.
Input: The orange input is used for the primary 2D image that is warped.

Effect Mask: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the Corner Positioner to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

Below, the Corner Positioner is used to position the rectangular corners of the MediaIn2 to fit within a specific area of the MediaIn1 node. A Planar Tracker tracks the background, and then a Planar Transform is used to keep the Corner Positioner in place as the background clip moves. Once the planar tracking is completed, and the Planar Transform is created, the Planar Tracker node is no longer needed, and you can delete it.

Inspector

The Corner Positioner Controls tab
**Controls Tab**
The Controls tab includes transform and offset adjustments for the four corners of the image.

**Mapping Type**
This determines the method used to project the image caused by the Corner Positioner. In Bi-Linear mode, a straight 2D warping takes place. In Perspective mode, the image is calculated with the offsets in 2D space and then mapped into a 3D perspective.

**Corners X and Y**
There are four points in the Corner Positioner. Drag these around to position each corner of the image interactively. Attach these control points to any of the usual modifiers.

The image input is deformed and perspective corrected to match the position of the four corners.

**Offset X and Y**
These controls can be used to offset the position of the corners slightly. This is useful when the corners are attached to Trackers with patterns that may not be positioned exactly where they are needed.

**Common Controls**

**Settings Tab**
The Settings tab in the Inspector is also duplicated in other Warp nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

---

**Dent [DNT]**

The Dent node creates a circular deformation of an image similar to a Fish Eye Lens effect, with the choice of six different Dent filters.

**Dent Node Introduction**
The Dent node creates a circular deformation of an image similar to a Fish Eye Lens effect, with the choice of six different Dent filters.

**Inputs**
The two inputs on the Dent node are used to connect a 2D image and an effect mask, which can be used to limit the warped area.

- **Input:** The orange input is used for the primary 2D image that is warped.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the Dent to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.

---
Basic Node Setup
The Dent node is used below to make a circular pattern based on a Fast Noise and a Mosaic Blur (DaVinci Resolve Resolve FX only). The Crop node at the end is used to set the desired resolution.

The Dent node can help create lens distortion effects or a motion graphics background.

Inspector

Controls Tab
The adjustments in the Controls tab are used to change the Dent style, position, size, and strength.

Type
Select the type of Dent filter to use from this menu. All parameters for the Dent can be keyframed.

Dent 1
This creates a bulge dent.

Kaleidoscope
This creates a dent, mirrors it, and inverts it.

Dent 2
This creates a displacement dent.

Dent 3
This creates a deform dent.

Cosine Dent
This creates a fracture to a center point.

Sine Dent
This creates a smooth rounded dent.

Center X and Y
This positions the Center of the Dent effect on the image. The default values are 0.5, 0.5, which center the effect in the image.

Size
This changes the size of the area affected by the dent. Animate this slider to make the dent grow.
Strength
This changes the overall strength of the dent.

Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other Warp nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Displace [DSP]

Displace Node Introduction
The Displace node uses a map image to displace or refract another image. This is useful for creating a vast range of effects from bevels and heat distortion to glass and water effects.

Inputs
There are three inputs on the Displace node: The primary image, the displacement map foreground image, and an effect mask.

– **Input**: The orange image input is a required connection for the primary image you wish to displace.

– **Foreground Image**: The green input is also required as the image used to displace the background. Once connected, you can choose red, green, blue, alpha, or luminance channel to create the displacement.

– **Effect Mask**: The optional blue effect mask input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the displacement to only those pixels within the mask. An effects mask is applied to the tool after it is processed.

Basic Node Setup
Below, the Displace node uses a Fast Noise to generate the Displace map. Increasing the seethe rate can produce heat distortion or flag waving effects.
Inspector

The Displace Controls tab

The Controls tab is used to change the style, position, size, strength, and lighting (embossing) of the displacement.

**Type**
The Type menu is used to choose in what mode the Displace node operates. The Radial mode uses the map image that refracts each pixel out from the center, while X/Y mode provides control over the amount of displacement along each axis individually.

**NOTE:** There is one set of Refraction controls while in Radial mode, and two sets in X/Y mode—one for each of the X and Y channels.

**Center (Radial Only)**
The Center control defines the point from which pixels are displaced toward or away.

**Refraction Channel**
This drop-down menu controls which channel from the foreground image is used to displace the image. Select from Red, Green, Blue, Alpha, or Luminance channels. In X/Y mode, this control appears twice, once for the X displacement and once for the Y displacement.

**Refraction Strength (Radial)**
Controls the strength of the refraction. Higher values cause stronger or more pronounced refraction.

**X and Y Refraction (X/Y)**
Two separate sliders appear to control the Refraction strength along the X- and Y-axis separately. Otherwise, this is exactly like Refraction Strength.

**Light Power**
This controls the intensity, or strength, of the simulated light, causing bright and dim areas to form according to the contour of the refraction image. Higher values cause the bright and dim areas to be more pronounced.

**Light Angle**
This sets the angle of the simulated light source.
Spread
This widens the Displacement effect and takes the edge off the Refraction map. Higher values cause the ridges or edges to spread out.

Light Channel
Select the channel from the refraction image to use as the simulated light source. Select from Color, Red, Green, Blue, Alpha, or Luminance channels.

NOTE: The Radial mode pushes pixels inward or outward from a center point, based on pixel values from the Displacement map. The XY mode uses two different channels from the map to displace pixels horizontally and vertically, allowing more precise results. Using the XY mode, the Displace node can even accomplish simple morphing effects. The Light controls allow directional highlighting of refracted pixels for simulating a beveled look.

Common Controls
Settings Tab
The Settings tab in the Inspector is also duplicated in other Warp nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Drip [DRP]

Drip Node Introduction
The Drip node creates a ripple effect over the entire image, which has the potential to animate outward from a central source. There are a variety of different Drip effects from which to choose.

Inputs
The two inputs on the Drip node are used to connect a 2D image and an effect mask, which can be used to limit the warped area.

– **Input**: The orange input is used for the primary 2D image that is warped.
– **Effect Mask**: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the warping to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup
Below, the Drip node is used to make rippling water-style effects using a MediaIn node.
The Drip node can be connected directly after a MediaIn node or any node providing a 2D output.

**Inspector**

**Controls Tab**

The Controls tab is used to change the style, position, size, strength, and phase for animating the "ripples" of the Drip.

**Shape**

Use this control to select the shape of the Drip.

**Circular**

This creates circular ripples. This is the default Drip mode.

**Square**

This creates even-sided quadrilateral drips.

**Random**

This creates a randomly dispersed noise that distorts your image and is similar to a particle effect.

**Horizontal**

This creates horizontal waves that move in one direction.

**Vertical**

This creates vertical waves that move in one direction.

**Exponential**

This creates a Drip effect that looks like a diamond shape with inverted, curved sides (an exponential curve flipped and mirrored).

**Star**

This creates an eight-way symmetrical star-shaped ripple that acts as a kaleidoscope when the phase is animated.
Radial
This creates a star-shaped ripple that emits from a fixed pattern.

Center X and Y
Use this control to position the center of the Drip effect in the image. The default is 0.5, 0.5, which centers the effect in the image.

Aspect
Control the aspect ratio of the various Drip shapes. A value of 1.0 causes the shapes to be symmetrical. Smaller values cause the shape to be taller and narrower, while larger values cause shorter and wider shapes.

Amplitude
The Amplitude of the Drip effect refers to the peak height of each ripple. Use the slider to change the amount of distortion the Drip applies to the image. A value of 0.0 gives all ripples no height and therefore makes the effect transparent. A maximum Amplitude of 10 makes each ripple extremely visible and completely distorts the image. Higher numbers can be entered via the text entry boxes.

Dampening
Controls the Dampening, or falloff, of the amplitude as it moves away from the center of the effect. It can be used to limit the size or area affected by the Drip.

Frequency
This changes the number of ripples emanating from the center of the Drip effect. A value of 0.0 indicates no ripples. Move the slider up to a value of 100 to correspond with the density of desired ripples.

Phase
This controls the offset of the frequencies from the center. Animate the Phase value to make the ripple emanate from the center of the effect.

Common Controls

Settings Tab
The Settings Tab in the Inspector is also duplicated in other Warp nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Grid Warp [GRD]

The Grid Warp node

Grid Warp Node Introduction
The Grid Warp node is a 2D deformation grid with flexible vertices. The image is deformed so that the source grid matches the destination grid.
**Inputs**

The two inputs on the Grid Warp node are used to connect a 2D image and an effect mask, which can be used to limit the warped area.

- **Input:** The orange input is used for the primary 2D image that is warped.
- **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the warping to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.

**Basic Node Setup**

Below, two Grid Warp nodes are used to warp different areas of a frame. This can be useful for chaining the framing in a shot or adding slight movement to a still. Using the Copy Src to Dest button, only the area modified by Grid Warp 2 is pasted as the foreground in the Merge.

The Grid Warp can be used to shift areas within a shot for reframing or adding animation to a still.

**Inspector**

The Grid Warp Controls tab

**Controls Tab**

The Controls tab contains parameters that configure the onscreen grid as well the type of distortion applied when a control point on the grid is moved.
Source and Destination
The Source and Destination buttons determine whether the source grid or destination grid is currently active. Only one grid can be displayed or manipulated at a time. The selected button is highlighted to indicate that it is the currently active grid.

All other controls in this tab affect the grid selected by this control.

Selection Type
These three buttons determine the selection types used for manipulating the points. There are three options available.

Selected
When in Selected mode, adjustments to the grid are applied only to the currently selected points. This mode is identical to normal polyline operation.

Region
In Region mode, all points within the area around the mouse pointer move when the mouse button is clicked. New points that enter the region during the move are ignored. Choosing this option exposes Magnet Distance and Magnet Strength controls to determine the size and falloff of the area.

Magnetic
In Magnetic mode, all points within the area around the mouse pointer move when the mouse button is clicked. New points that enter the region during the move are affected as well. Choosing this option exposes Magnet Distance and Magnet Strength controls to determine the size and falloff of the area.

Magnet Distance
The default node for selecting and manipulating the grid is a Magnet node. The magnet is represented in the viewer by a circle around the mouse pointer. The Magnet Distance slider controls how large the region of effect for the magnet is, as in the size of the circle. Drag on the grid and any vertex within the range of the slider moves.

To increase the size of the magnet, increase the value of this slider. Alternately, adjust the size of the magnet by holding down the D key while dragging the mouse.

Magnet Strength
The Magnet Strength slider increases or decreases the falloff of the magnet cursor’s effect. At a setting of 0.0, the magnetic cursor has no effect, and vertices do not move at all. As the values increase, the magnet causes a greater range of motion in the selected vertices. Use smaller values for a more sensitive adjustment and larger values for broad-sweeping changes to the grid.

X and Y Grid Size
The X and Y Grid Size sliders control the number of divisions in the grid. Where the X and Y divisions intersect, a control vertex is created.

Be aware that changing either of these controls after applying changes in the grid resets the entire grid. Set the X and Y grid sizes to the appropriate resolution before making detailed adjustments to the grid.

Subdivision Level
The Subdivision Level determines how many subdivisions there are between each set of divisions. Subdivisions do not generate vertices at intersections. The more subdivisions, the smoother the deformation is likely to be, but the slower it is to render.

Center
The Center coordinates determine the exact center of the grid. The onscreen Center control is invisible while editing the grid. Select the Edit Rect mode, and the grid center becomes visible and available for editing.
Use the Center control to move the grid through a scene without affecting the animation applied to the individual vertices. For example, while deforming lips, track the motion of the face with a Tracker, and connect the grid center to the Tracker. This matches the grid with slight movements of the head while focusing on the deformation of the lips.

**Angle**
This Angle control rotates the entire grid.

**Size**
The Size control increases or decreases the scale of the grid.

**Edit Buttons**
There are four edit modes available, each of which can be selected by clicking on the appropriate button.

**Edit None**
Set the grid to Edit None mode to disable the display of all onscreen controls.

**Edit Grid**
The Edit Grid mode is the default mode. While this mode is enabled, the grid is drawn in the viewer, and the control vertices of the grid can be manipulated directly.

**Edit Rectangle**
When the grid is in Edit Rectangle mode, the onscreen controls display a rectangle that determines the dimensions of the grid. The sides of the rectangle can be adjusted to increase or decrease the grid’s dimension. This mode also reveals the onscreen Center control for the grid.

**Edit Line**
The Edit Line mode is beneficial for creating grids around organic shapes. When this mode is enabled, all onscreen controls disappear, and a spline can be drawn around the shape or object to be deformed. While drawing the spline, a grid is automatically created that best represents that object. Additional controls for Tolerance, Over Size, and Snap Distance appear when this mode is enabled. These controls are documented below.

**Set Mesh to Entire Image**
The Set Mesh to Entire Image button automatically resets the size of the grid to the exact dimensions of the image. Any adjustments to vertices within the grid are reset.

**Copy Buttons**
These two buttons provide a technique for copying the exact shape and dimensions of the source grid to the destination, or the destination grid to the source. This is particularly useful after setting the source grid to ensure that the destination grid’s initial state matches the source grid before beginning a deformation.

**Point Tolerance**
This control is visible only when the Edit Line mode is enabled. The Point Tolerance slider determines how much tessellation the grid applies to match the density of points in the spline closely. The lower this value, the fewer vertices there are in the resulting grid, and the more uniform the grid appears. Higher values start applying denser grids with variations to account for regions in the spline that require more detail.

**Oversize Amount**
This control is visible only when the Edit Line mode is enabled. The Oversize Amount slider is used to set how large an area around the spline should be included in the grid. Higher values create a larger border, which can be useful when blending a deformation back into the source image.
Snap Distance
This control is visible only when the Edit Line mode is enabled. The Snap Distance slider dictates how strongly the drawn spline attracts surrounding vertices. If a vertex is close enough to a spline’s edge, the vertex moves to line up with the spline. The higher the value, the farther the reach of the spline.

Right-Click Here for Mesh Animation
The grids are static by default. Right-clicking on the Right-Click Here for Mesh Animation label provides a contextual menu with options for animating the grid or connecting it to another grid in the composition.

The grid uses a Polychange spline. Any adjustment to the control points adds or modifies the keyframe for all points on that spline.

Right-Click Here for Shape Animation
This label appears only in the Edit Line mode. Right-clicking on the Right-Click Here for Shape Animation label reveals a pop-up menu used to animate the shaping polyline or to connect it to other polylines.

Render Tab
The Render tab controls the final rendered quality and appearance of the warping.

Render Method
The Render Method drop-down menu is used to select the rendering technique and quality applied to the mesh. The three settings are arranged in order of quality, with the first, Wireframe, as the fastest and lowest of quality. The default mode is Render, which produces final resolution, full-quality results.

Anti-Aliasing
The Anti-Aliasing control appears only as a checkbox when in Wireframe Render mode.

In other modes, it is a drop-down menu with three levels of quality. Higher degrees of anti-aliasing improve image quality dramatically but vastly increase render times. The Low setting may be an appropriate option while setting up a large dense grid or previewing a node tree, but rarely for a final render.

Filter Type
When the Render Method is set to something other than Wireframe mode, the Filter Type menu is visible and set to Area Sample. This setting prevents the grid from calculating area samples for each vertex in the grid, providing good render quality. Super Sample can provide even better results but requires much greater render times.
**Wireframe Width**
This slider appears only when the Render Method is set to Wireframe. It determines the width of the lines that make up the wireframe.

**Anti-Aliased**
This checkbox appears only when the Render Method is set to Wireframe. Use this checkbox to enable/disable anti-aliasing for the lines that make up the wireframe.

**Black Background**
The Black Background checkbox determines whether pixels outside of the grid in the source image are set to black or if they are preserved.

**Object ID and Material ID**
Enable the Object ID or Material ID checkboxes to have the grid output the proper ID channel in the final render.

**Set Image Coordinates at Subdivision Level**
This checkbox defaults to enabled and sets the image coordinates at the subdivision level.

**Force Destination Render**
This checkbox defaults to enabled and forces a destination render.

**Contextual Menu Options**
The Grid Warp node places a submenu for both source and destination grids in the viewer’s contextual menu. Both menus have the exact same name, where only the menu for the active grid is populated with options. The other menu is empty. The contextual menu options are also available from the toolbar that appears in the viewer.
Modify Only/Done
These two options set the mesh to Modify Only and Done modes, respectively. Select Modify Only to edit the mesh or Modify Done to prevent any further changes to a mesh.

Smooth/Linear
Use Smooth and Linear options to apply or remove smoothing from selected vertices.

Auto Smooth Points
When Auto Smooth Points is enabled, the vertices in the grid are automatically smoothed whenever they are moved. This is generally enabled by default.

Z Under/Z Same/Z Over
When two vertices in a grid overlap, one ends up getting clipped by the other. Z Under, Z Same, and Z Over are used to select which vertices are rendered on top and which are rendered behind.

Select All
This option selects all points in the mesh.

Show Key Points, Handles, Grid, and Subdivisions
Use these four options to enable or disable the display of the grid, key points (vertices), Bézier handles, and subdivisions in the viewers.

Reset Selected Points
This resets Selected Points (vertices) to their default positions.

Reset All Points
This resets all points (vertices) in the mesh to their default positions.

Stop Rendering
This option stops rendering, which disables all rendering of the Grid Warp node until the mode is turned off. This is frequently useful when making a series of fine adjustments to a complex grid.

Grid Warp Toolbar
Whenever the Grid Warp node is selected and is in Edit Grid mode, the Grid Warp toolbar is displayed in the views. This toolbar provides a variety of options for manipulating and adjusting the grid. The toolbar buttons in this toolbar are described in the preceding “Contextual Menu Options” section.

The Grid Warp viewer toolbar

Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other Warp nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.
Lens Distort [LENS]

The Lens Distort node

Lens Distort Node Introduction

This node can be used to remove or add lens distortion in an image. The lens distortion in an image depends on the lens, quality, number of elements, and many other factors.

One reason to remove lens distortion is to composite with an undistorted layer. For example, compositing a 3D element over a distorted live-action layer will cause unwanted effects like straight lines not matching up on the foreground and background. The resulting composite will not look believable.

Inputs

The two inputs on the Lens Distort node are used to connect a 2D image and an effect mask, which can be used to limit the distorted area.

– **Input:** The orange input is used for the primary 2D image that is distorted.
– **Effect Mask:** The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the distortion to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.

Basic Node Setup

A simplified example below applies the Lens Distort in Undistort mode to the MediaIn1 live-action layer, composites the 3D elements, and finally applies the Lens Distort at the end with the same settings, but this time in Distort mode to get the original look and distortion back into the image.

Lens Distort applied on the live-action media at the beginning of the node tree, and once again at the end.
Inspector

The Lens Distort Controls tab

The Controls tab presents various ways to customize or build the lens distortion model you want. Camera Settings allow you to specify the camera used to capture the content.

**Mode**

Undistort removes the lens distortion to create a flattened image. Distort brings the original lens distortion back into the image.

**Edges**

Determines how samples that fall outside the frame are treated.

- **Canvas**: Pixels outside the frame are set to the default canvas color. In most cases, this is black with no alpha.
- **Duplicate**: Pixels outside the frame are duplicated. This results in “smeared” edges but is useful when, for example, applying a blur because in that case black pixels would result in the unwanted blurring between the actual image and the black canvas.

**Clipping Mode**

- **Domain**: Retains all pixels that might be moved out of the frame for later re-distorting.
- **Frame**: Pixels moved outside the frame are discarded.
**Output Distortion Map**
Outputs the location of pixels as a warped screen-coordinate map.

**Camera Settings**
The options known from the Camera 3D are duplicated here. They can either be set manually or connected to an already existing Camera 3D.

**Lens Distortion Model**
Select the appropriate 3D Equalizer Lens Distortion model here: 3DE Classic Model, 3DE4 Anamorphic, 3DE4 Radial Fisheye, or 3DE4 Radial. Please consult the 3D Equalizer manual for further explanation. The sliders in the 3DE Classic LD Model are most likely best suited for manually applying (un)distortion, without having imported lens data.

**Supersampling [HiQ]**
Sets the number of samples used to determine each destination pixel. As always, higher supersampling leads to higher render times. 1×1 bilinear is usually of sufficient quality, but with high lens distortion near the edges of the lens, there are noticeable differences to higher settings.

**Supersampling Mode [HiQ]**
The type of sample done for each supersample. Nearest leads to a crisper but more aliased image. Bi-Linear gives a blurrier result.

**Load Distortion Data**
Allows the user to load a Lens Distortion profile created, for example, by the 3D Equalizer.

**How to Manually Determine Lens Distortion**
In an ideal world, one would have exact lens parameters from each lens that was used during the shoot, and one could use those values to undistort the image. However, in the real world, those parameters have not been taken on set or don’t match. Another approach is to use software like 3D Equalizer, which analyzes the footage and delivers a dataset that can be imported into the Lens Distort node right away.

And finally, one could try to manually eyeball the amount of lens distortion using the control sliders. To do that, one could either look for horizontal or vertical lines in the footage that are supposed to be straight and straighten them out using the controls, or shoot a full-frame checkerboard pattern on set as a reference.

**Common Controls**

**Settings Tab**
The Settings tab in the Inspector is also duplicated in other Warp nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

---

**Perspective Positioner [PPN]**

![The Perspective Positioner node](image)
**Perspective Positioner Node Introduction**

The Perspective Positioner is the complementary node to the Corner Positioner node. It “unpins” an image by positioning corner points on a perspective distorted area, thereby removing the perspective from the image. This function can also be used to wobble and warp the image by animating the points over time.

**Inputs**

The two inputs on the Perspective Positioner node are used to connect a 2D image and an effect mask, which can be used to limit the transformed area.

- **Input**: The orange input is used for the primary 2D image that is transformed.
- **Effect Mask**: The blue input is for a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the transform to only those pixels within the mask. An effects mask is applied to the tool after the tool is processed.

**Basic Node Setup**

In the example below, the Perspective Positioner is used to unpin a perspective distorted area of the MedianIn2 in order to paint on the flat texture. The MedianIn2 is then corner pinned back into place. The Perspective Positioner and Corner Positioner do not concatenate, so some softness is introduced with these nodes.

![Basic Node Setup Diagram](image)

The Perspective Positioner unpins an image to paint on a texture map.

**Inspector**

![Inspector Image](image)

The Perspective Positioner Controls tab
Controls Tab
The Controls tab contains parameters for selecting vector channels and controlling how much distortion they apply to an image.

Mapping Type
The Mapping Type menu is used to select the type of transform used to distort the image. Bi-Linear is available for support of older projects. Leaving this on Perspective is strongly suggested since the Perspective setting maps the real world more accurately.

Corners X and Y
There are the four control points of the Perspective Positioner. Interactively drag these in the viewers to position each corner of the image. You can refine their position using the Top, Bottom, Left, and Right controls in the Inspector.

Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other Warp nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

Vector Distortion [DST]

Vector Distortion Node Introduction
The Vector Distortion node distorts the main source image along the X- and Y-axis separately, based on the vector channel data in the source image or vector channels from a second reference image.

Inputs
There are three inputs on the Vector Distort node for the primary 2D image, the distort image with vector channels and an effect mask.

- **Input**: The orange image input is a required connection for the primary image you wish to distort. If this image has vector channels, they are used in the distortion.
- **Distort**: The green input is an optional distort image input used to distort the background image based on vector channels. Once connected, it overrides vector channels in the input image.
- **Effect Mask**: The optional blue effect mask input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the displacement to only those pixels within the mask. An effects mask is applied to the tool after it is processed.

Basic Node Setup
In the example below, the MediaIn1 node uses an Optical Flow node to generate the vector channels, which are then passed on to the Vector Distort node. MediaIn2 is distorted and composited over the background.
The Vector Distort node relies on the image having vector channels or an Optical Flow node to generate them.

Inspector

The Vector Distortion Controls tab

Controls Tab
The Controls tab contains parameters for selecting vector channels and controlling how much distortion they apply to an image.

X Channel and Y Channel
These two menus are used to select which channel of the (green) distort image input is used to distort the X and Y channels. If no distort reference image is connected, then channels from the main orange input are used instead.

Flip Channel X and Flip Channel Y
Use these checkboxes to flip the direction of the distortion along the specified axis.

Lock Scale X/Y
Select this checkbox to separate the Scale slider into separate Scale X and Scale Y sliders.

Scale
Use the Scale slider to apply a multiplier to the values of the distortion reference image.

Lock Bias X/Y
Select this checkbox to separate the Bias slider into separate Bias X and Bias Y sliders.

Center Bias
Use the Center Bias slider to shift or nudge the distortion along a given axis.
Edges
This menu determines how the edges of the image are treated.

- **Canvas:** This causes the edges that are revealed by the shake to be the canvas color—usually transparent or black.
- **Duplicate:** This causes the edges to be duplicated, causing a slight smearing effect at the edges.

Glow
Use this slider to add a glow to the result of the vector distortion.

Common Controls

Settings Tab
The Settings tab in the Inspector is also duplicated in other Warp nodes. These common controls are described in detail at the end of this chapter in “The Common Controls” section.

**Vortex [VTX]**

The Vortex node

Vortex Node Introduction
The Vortex effect appears as a swirling whirlpool in specified regions of the image. The Vortex can be made to move and grow by animating the various controls.

Inputs
There are two inputs on the Vortex node for the primary 2D image and the effect mask.

- **Input:** The orange image input is a required connection for the primary image you wish to swirl.
- **Effect Mask:** The optional blue effect mask input expects a mask shape created by polylines, basic primitive shapes, paint strokes, or bitmaps from other tools. Connecting a mask to this input limits the swirling vortex to only those pixels within the mask. An effects mask is applied to the tool after it is processed.

Basic Node Setup
Below, the Vortex is applied to text for creating motion graphics. Since the Vortex will cause the text to swirl outside the text boundary, a Set Domain node is used to expand the text boundary, ensuring that the text is not cropped when the Vortex is applied.
The Vortex is used to create swirling whirlpool effects.

**Inspector**

The Vector Distortion Controls tab

**Controls Tab**

The Controls tab contains parameters for adjusting the position, size, and strength of the Vortex effect.

**Center X and Y**

This control is used to position the center of the Vortex effect on the image. The default is 0.5, 0.5, which positions the effect in the center of the image.

**Size**

Size changes the area affected by the Vortex. You can drag the circumference of the effect in the viewer or use the Size slider.

**Angle**

Drag the rotation handle in the viewer or use the thumbwheel control to change the amount of rotation in the Vortex. The higher the angle value, the greater the swirling effect.

**Power**

Increasing the Power slider makes the Vortex smaller but tighter. It effectively concentrates it inside the given image area.

**Common Controls**

**Settings Tab**

The Settings tab in the Inspector is also duplicated in other Warp nodes. These common controls are described in detail in the following “The Common Controls” section.
The Common Controls

Nodes that handle Warp operations share a number of identical controls in the Inspector. This section describes controls that are common among Warp nodes.

Inspector

Settings Tab

The Settings tab in the Inspector can be found on every tool in the Warp category. The Settings controls are even found on third-party Warp-type plug-in tools. The controls are consistent and work the same way for each tool.

Blending Control

The Blend control is used to blend between the tool’s original image input and the tool’s final modified output image. When the blend value is 0.0, the outgoing image is identical to the incoming image. Normally, this will cause the tool to skip processing entirely, copying the input straight to the output.

Process When Blend Is 0.0

The tool is processed even when the input value is zero. This can be useful if the node is scripted to trigger a task, but the node’s value is set to 0.0.
Red/Green/Blue/Alpha Channel Selector
These four buttons are used to limit the effect of the tool to specified color channels. This filter is often applied after the tool has been processed.

For example, if the Red button on a Blur tool is deselected, the blur will first be applied to the image, and then the red channel from the original input will be copied back over the red channel of the result.

There are some exceptions, such as tools for which deselecting these channels causes the tool to skip processing that channel entirely. Tools that do this will generally possess a set of identical RGBA buttons on the Controls tab in the tool. In this case, the buttons in the Settings and the Controls tabs are identical.

Apply Mask Inverted
Enabling the Apply Mask Inverted option inverts the complete mask channel for the tool. The mask channel is the combined result of all masks connected to or generated in a node.

Multiply by Mask
Selecting this option will cause the RGB values of the masked image to be multiplied by the mask channel’s values. This will cause all pixels of the image not included in the mask (i.e., set to 0) to become black/transparent.

Use Object/Use Material (Checkboxes)
Some 3D software can render to file formats that support additional channels. Notably, the EXR file format supports Object ID and Material ID channels, which can be used as a mask for the effect. These checkboxes determine whether the channels will be used, if present. The specific Material ID or Object ID affected is chosen using the Object and Material ID sliders explained below.

Correct Edges
This checkbox appears only when the Use Object or Use Material checkboxes are selected. It toggles the method used to deal with overlapping edges of objects in a multi-object image. When enabled, the Coverage and Background Color channels are used to separate and improve the effect around the edge of the object. If this option is disabled (or no Coverage or Background Color channels are available), aliasing may occur on the edge of the mask.

For more information on the Coverage and Background Color channels, see Chapter 18, “Understanding Image Channels” in the Fusion Reference Manual or Chapter 79 in the DaVinci Resolve Reference Manual.

Object ID/Material ID (Sliders)
Use these sliders to select which ID will be used to create a mask from the object or material channels of an image. Use the Sample button in the same way as the Color Picker: to grab IDs from the image displayed in the viewer. The image or sequence must have been rendered from a 3D software package with those channels included.

Motion Blur
– **Motion Blur**: This toggles the rendering of Motion Blur on the tool. When this control is toggled on, the tool’s predicted motion is used to produce the motion blur caused by the virtual camera’s shutter. When the control is toggled off, no motion blur is created.

– **Quality**: Quality determines the number of samples used to create the blur. A quality setting of 2 will cause Fusion to create two samples to either side of an object’s actual motion. Larger values produce smoother results but increase the render time.

– **Shutter Angle**: Shutter Angle controls the angle of the virtual shutter used to produce the motion blur effect. Larger angles create more blur but increase the render times. A value of 360 is the equivalent of having the shutter open for one full frame exposure. Higher values are possible and can be used to create interesting effects.
– **Center Bias**: Center Bias modifies the position of the center of the motion blur. This allows for the creation of motion trail effects.

– **Sample Spread**: Adjusting this control modifies the weighting given to each sample. This affects the brightness of the samples.

**Use GPU**

The Use GPU menu has three settings. Setting the menu to Disable turns off GPU hardware-accelerated rendering. Enabled uses the GPU hardware for rendering the node. Auto uses a capable GPU if one is available and falls back to software rendering when a capable GPU is not available.

**Hide Incoming Connections**

Enabling this checkbox can hide connection lines from incoming nodes, making a node tree appear cleaner and easier to read. When enabled, empty fields for each input on a node will be displayed in the Inspector. Dragging a connected node from the node tree into the field will hide that incoming connection line as long as the node is not selected in the node tree. When the node is selected in the node tree, the line will reappear.

**Comments**

The Comments field is used to add notes to a tool. Click in the empty field and type the text. When a note is added to a tool, a small red square appears in the lower-left corner of the node when the full tile is displayed, or a small text bubble icon appears on the right when nodes are collapsed. To see the note in the Node Editor, hold the mouse pointer over the node to display the tooltip.

**Scripts**

Three Scripting fields are available on every tool in Fusion from the Settings tab. They each contain edit boxes used to add scripts that process when the tool is rendering. For more details on scripting nodes, please consult the Fusion scripting documentation.
This chapter details the modifiers available in Fusion.

Contents

Modifiers  2450
Anim Curves  2450
Bézier Spline  2453
B-Spline  2454
Calculation  2455
CoordTransform Position  2457
Cubic Spline  2458
Expression  2458
From Image  2463
Gradient Color  2464
Key Stretcher Modifier  2466
MIDI Extractor  2466
Natural Cubic Spline  2470
Offset (Angle, Distance, Position)  2470
Path  2473
Perturb  2474
Probe  2476
Publish  2478
Resolve Parameter  2478
Shake  2479
Track  2481
Vector Result  2482
XY Path  2483
Modifiers

Modifiers are extensions to a node’s standard set of parameters found in the Inspector; in fact, modifiers are designed to control other parameters. They can be as simple as a motion path or linking two parameters. However, they can also be elaborate expressions, procedural functions, external data, third-party plug-ins, or scripted Fuses. You can add modifiers by right-clicking over a parameter in the Inspector and choosing a modifier from the menu. Alternatively, you can right-click a control in the viewer. Not all modifiers are displayed in the right-click menu for all parameters. Some modifiers work only on specific parameter types.

**NOTE:** Text3D and Text+ have additional text-specific modifiers, which are covered in their nodes’ sections.

Anim Curves

The Animation Curves modifier (Anim Curves) is used to dynamically adjust the timing, values, and acceleration of an animation, even if you decide to change the duration of a comp. Using this modifier makes it infinitely easier to stretch or squish animations, create smooth motion, add bouncing properties, or mirror animations curves without the complexity of manually adjusting splines.
When creating Fusion templates for the Edit and Cut page in DaVinci Resolve, the Anim Curves modifier allows the keyframed animation you’ve created in Fusion to stretch and squish appropriately as the transition, title, or effect’s duration changes on the Edit and Cut page Timelines.

**Curve Shape Controls**

The controls for the Anim Curves modifier appear in the modifier’s tab of the Inspector. The Curve Shape controls determine the acceleration or shape of the animation curve.

- **Source:** This drop-down menu has three options based on how the comp is created from DaVinci Resolve’s Edit page.
  - **Transition:** This setting is automatically selected when the comp is created from an Edit page transition effect. If the duration of the transition is updated in the Edit page, the timing of the animation updates as well.
  - **Duration:** Use this setting when the comp is created from a clip on the Edit page. The animation timing will update if the clip’s duration changes by trimming.
  - **Custom:** Displays an Input dial to manually control the timing.

- **Input:** This dial is only visible when Source is set to Custom. It is used to change the input keyframe value.

- **Curve:** The Curve drop-down menu selects the interpolation method used between keyframes. The three choices are: linear, easing, or custom.
  - **Linear:** The default Linear interpolation method maintains a fixed, consistent acceleration between keyframes.
  - **Easing:** Displays interpolation menus for both the start of the curve (In) and the end of the curve (Out).
  - **Custom:** Opens a mini Spline Editor to customize the interpolation from the start of the animation to the end.

- **Mirror:** Plays the animation forward, and after reaching the end, it returns to the starting value. This causes the initial animation to be twice as fast, since the second half of the comp is used for the reverse animation.

- **Invert:** Flips the animation curve upside-down so that the values start high and end low.

**Scaling**

The Scale parameters modify the animation values using relative adjustments.

- **Scale:** This number is a multiplier applied to the value of the keyframes. If the Scale value is 2 and a keyframe has a value of 0, it remains 0. If the Scale value is 2 and a keyframe has a value of 10, the result is as if the keyframe is set to 20. This can be thought of as the ending value for the animation. It is best to set this while viewing the last frame in the comp.

- **Offset:** The offset is added to the keyframe values and can be thought of as the starting value for the animation. It is best to set this while viewing the first frame in the comp.

- **Clip Low:** Ensures the output value never dips below 0.0.

- **Clip High:** Ensures the output value never exceeds 1.0.
Timing
The Timing parameters adjust the animation timing using relative values.

– **Time Scale:** Stretches or squishes the animation, causing it to run faster or slower. A value of 1.0 keeps the animation running for the comp’s duration (unless you have customized the animation using other controls in the Modifier).

– **Time Offset:** This value delays the animation as a fraction of its total duration. A value of 0.0 applies no delay. A value of 0.5 delays the animation starting point midway into the comp’s duration.

Using the Anim Curves Modifier to Create a Custom Transition
To understand how to use the Anim Curves modifier for a transition, let’s create a simple scaling dissolve.

1. Add a standard cross dissolve in the Edit page Timeline.
2. Right-click over the transition and choose Convert to Fusion Cross Dissolve.
3. Right-click over the transition again and choose Open in Fusion page.
4. Add a Transform node to MediaIn1 and to MediaIn2.
5. Select the Transform node attached to the MediaIn2.
6. In the Inspector, right-click the Size control, then choose Modify With > Anim Curves from the contextual menu. Adding this modifier to the Size control will cause the slider to animate from 0 to 1 for the Cross Dissolve’s duration.
7. Select the Transform node attached to the MediaIn1.
8. In the Inspector, right-click the Size control, then choose Modify With > Anim Curves from the contextual menu.
9. At the top of the Inspector, click the Modifier tab and click the Invert button. Inverting the animation curves causes MediaIn1 to scale opposite of MediaIn2.
10. In the Modifiers tab, set the Curve drop-down menu to Easing, and experiment with the different ease-in ease-out curve types from the In/Out drop-down menus.

Once you create a Macro from this node tree and save it as a Transition template, you can apply it in the Edit page Timeline. If you change the transition duration in the Edit page, the animation timing will update appropriately.

Using the Anim Curves Modifier with Paths
To understand how to use the Anim Curves modifier’s with a Path modifier, let’s use the premise that you want to create text that falls from the top of the frame and bounces as it reaches the bottom of the frame.

1. In Fusion, create two keyframes that cause text to start at the top of the frame and drop to the bottom. This automatically creates a Path modifier.
2. In the Inspector’s Modifier tab, right-click over the Displacement parameter and choose Insert > Anim Curves. The animation is normalized to the duration of the comp.
3. Set the Source menu to Duration, since this is not a transition and we are not customizing the duration.
4. From the Curve menu, choose Easing, then for the Out menu, choose Bounce.
5. Play the animation to see the Bounce animation.
6. To make the bounce occur halfway down the frame, change the Scale to .05.
7. To make the animation run twice as fast, enter 2.0 in the Time Scale parameter.
Once you create a macro from this node tree and save it as a Title template, you can apply it in the Edit page Timeline. If you change the title’s duration in the Edit page, the animation timing will update appropriately.

**TIP:** To view the resulting animation curve in the Spline Editor, select the parameter name in the Spline Editor’s header. The spline is updated as you change the controls.

## Bézier Spline

The Bézier Spline is one of the animation modifiers in Fusion and is typically applied to numerical values rather than point values. It is automatically applied when you keyframe a parameter or each time you right-click a number field and select Animate.

### Usage

You can add the Bézier Spline to the Spline Editor by right-clicking a number field and selecting BezierSpline. Since this is the most common choice for animation splines, it is separated from the Modify With menu for quicker access. Selecting BezierSpline from the menu adds a keyframe at the current location and displays a Bézier Spline in the Spline Editor.

Unlike most modifiers, this modifier has no actual Controls tab in the Inspector. However, the Spline Editor displays the Bézier Spline, and it can be controlled there. The Bézier Spline offers individual control over each control point’s smoothness using Bézier handles. The smoothness is applied in multiple ways:

- To make the control points smooth, select them, and press Shift-S. The handles can be used to modify the smoothness further.
– To make the control points linear, select them, and press Shift-L. These operations can also be performed using the contextual menu.

– Select the control point(s), right-click, and select Smooth or Linear. The menu also allows the user to smooth a spline using a convolution analysis called a Savitzky-Golay filter. Select the control point(s), right-click, and select Smooth Points -Y Dialog.

Ease In/Out

Traditional Ease In/Out can also be modified by using the number field virtual sliders in the Spline Editor. Select the control points you want to modify, right-click, and select Ease In/Out... from the contextual menu. Then use the number field virtual sliders to control the Ease In/Out numerically.

B-Spline

An alternative to the Bézier Spline, B-spline is another animation modifier in Fusion and is typically applied to numerical values rather than point values. It is applied by right-clicking a parameter and selecting Modify With > B-Spline.

Usage

– This animation spline modifier has no actual Controls tab. However, the Spline Editor displays the B-spline, and it can be controlled there. Notice that, though the actual value of the second keyframe is 0, the value of the resulting spline is 0.33 due to the unique smoothing and weighing algorithms of a B-spline.

– The weight can be modified by clicking the control point to select it, holding the W key, and moving the mouse left and right to lower or increase the tension. This is also done with multiple selected control points simultaneously.
Calculation

Calculations are used to create indirect connections between parameters. A Calculation can perform a mathematical expression based on two operands, where each operand can be connected to another parameter or set manually.

Additionally, using Time offsets and Scale controls in the Time tab, the Calculation control can access values of a parameter at times other than the current time.

The Calculation’s most common use is for connecting two parameters when one value range or scope is inappropriate for the other parameter.

**NOTE:** The Expression modifier is essentially a more flexible version of the Calculation modifier, with a single exception. It is far easier to manipulate the timing of the operands provided in the Calculation modifier than it is to do so with an Expression.

Inspector

![Calculation Calc tab](image)

**Calc Tab**

The Calc tab includes two dials used for the connected parameter and value that gets mathematically combined. The Operator menu selects how the Second Operand value combines with the parameter’s value.

**First and Second Operand**

These sliders are connected to published or animated parameters or manually set to the desired values for the calculation.

**Operator**

Select from the mathematical operations listed in this menu to determine how the two operands are combined. Clicking the drop-down arrow opens the menu with the following options:

- Add
- Subtract (First - Second)
- Multiply
- Divide (First / Second)
- Divide (Second / First)
- Subtract (Second - First)
- Minimum
- Maximum
- Average
- First only

![Calculation Time tab](image)
Time Tab

The Time tab is used to modify the time of the Calculation modifier. The controls here retime the speed of the effect or offset it in time.

First and Second Operand Time Scale

These sliders multiply the frame number and return the value of the operands at the multiplied frame number. A value of 1 returns the value of the operand at frame x when the composition is on frame x. For example, if the first operand is animated with a value of 1 to 50 from frame 0 to 10, then a scale of 0.5 would cause the calculation to return a value of 25 at frame 10 (effectively slowing the animation by half for the purposes of the calculation).

First Operand and Second Operand Time Offset

These sliders return the value of the operand at the Time Offset specified. A value of 10 would return the value of the operand 10 frames forward in time, and -10 would return the value of the operand 10 frames back in time. See the example below for a practical example.

Example

The following example uses a calculation to apply blur to a Text node in inverse proportion to the size of the text.

1. Open a new composition that starts on frame 0 and ends on frame 100.
2. At frame 0, add a Text+ node to the composition.
3. Enter a small amount of text and set the size to 0.05
4. Click the Keyframe button to the right of the Size slider to add a keyframe.
5. Move to frame 100 and set the Size value to 0.50.
6. Connect a Blur node after the Text+ node.
7. View the Blur node in one of the viewers.

   To have the blur decrease in strength as the text gets bigger, a simple “pick whip”-style parameter linking does not work. The controls cannot be directly connected together because the values of the Text Size control are getting bigger instead of smaller.

8. Right-click the Blur Size and select Modify With > Calculation from the contextual menu.
   This adds a Calculation modifier to the Blur node. At the top of the Inspector, a new set of controls appears in the Modifiers tab while the Blur node is selected.
9. At the top of the Inspector, select the Modifiers tab (F11).
10. Right-click the First Operand slider and select Connect To > Text 1 > Size from the contextual menu.
   Although the Blur Size is now connected to the Text Size parameter, this connection isn’t very useful. The maximum value of the Blur Size control is 0.5, which is hardly noticeable as a blur.
11. Set the Operator drop-down menu to Multiply.
12. Set the Second Operand slider to 100.

   Now the first operand is multiplied by 100, and adjusting the dial gives you a much blurrier blur.
Switch to the Time tab of the modifier and set the First Operand Time Scale to -1.0.

Normally, the first operand gets the value of the control it is connected to from the same frame as the current time. So at frame 10, the first operand is set to the same value as the Text size at frame 10. By setting this value to -1, the value is read from one frame back in time whenever the current time of the composition advances by 1 frame.

However, this means that the Calculation would be reading the value of the Text size at frame -10 when we are at frame 10 in the composition.

To correct for this, set the First Operand Time Offset slider to 100.

Return to the Tools tab at the top of the Inspector and press Play (Spacebar) to watch how the value of the Blur Size relates to the value of the Text Size.

---

**CoordTransform Position**

Because of the hierarchical nature of 3D in Fusion, the original position of an object in a 3D scene often fails to indicate the current position of the object. For example, an image plane might initially have a position at 1, 2, 1, but then be scaled, offset, and rotated by other tools further downstream in the node tree, ending up with an absolute location of 10, 20, 5. This can complicate connecting an object further downstream in the composition directly to the position of an upstream object. The Coordinate Transform modifier can be added to any set of the XYZ coordinate controls to calculate the current position of a given object at any point in the scene hierarchy. To add a Coordinate Transform modifier, right-click the numeric input on any node, and select Modify With > CoordTransform Position from the contextual menu.

**Inspector**

The Coordinate Transform modifier Controls tab

**Controls Tab**

The Controls tab has two fields for the target and scene input. The target is for the node continuing the original coordinates, while the scene input is used for the scene with the new coordinates.

**Target Object**

This control is connected to the 3D tool that produces the original coordinates to be transformed. To connect a tool, drag the node from the Node Editor into the text edit control, or right-click the control and select the tool from the contextual menu. It is also possible to type the tool’s name directly into the control.

**SubID**

The SubID slider can be used to target an individual sub-element of certain types of geometry, such as an individual character produced by a Text 3D tool or a specific copy created by a Duplicate 3D tool.
Scene Input

This control should be connected to the 3D tool, which outputs the scene containing the object at the new location. To connect a tool, drag and drop a tool tile from the Node Editor into the text edit control, or right-click the control and select an object from the Connect To pop-up menu.

Cubic Spline

The Cubic Spline is another animation modifier in Fusion that is normally applied to numerical values rather than point values. It can be applied by right-clicking a numerical control and selecting Modify With > Natural Cubic Spline.

Usage

Being an animation spline, this modifier has no actual Controls tab. However, its effect can be seen and influenced in the Spline Editor.

Expression

An expression is a variable or a mathematical calculation added to a parameter, rather than a straight numeric value. You can add an expression to any parameter in Fusion, or you can add the Expression modifier, which adds several tabs to the modifier Inspector. Adding this modifier to a parameter adds the ability to manipulate that parameter based on any number of controls, either positional or value-based. This modifier offers exceptional flexibility compared to the more limited Calculation or Offset modifiers, but it is unable to access values from frames other than the current time.

The Expression modifier accepts nine value inputs and nine position inputs that are used as part of a user-defined mathematical expression to output a value.

To add the Expression modifier to a parameter, right-click the parameter in the Inspector and choose Modify With > Expression from the contextual menu. The type of value returned by the Expression depends entirely on the type of control it is modifying.

When used with a value control (like a slider), the Expression in the Number Out tab is evaluated to create the result. When used to modify a positional control (like Center), the Point Out tab controls the result.

The Inspector’s Modifiers tab contains the controls for the Expression modifier, described below.
Inspector

Expressions modifier controls

Controls Tab

This tab provides nine number controls and nine point controls. The values of the number controls can be referred to in an expression as n1 through n9. The X-coordinate of each point control can be referred to as p1x through p9x, while the Y-coordinate is p1y through p9y.

These values can be set manually, connected to other parameters, animated, and even connected to other Expressions or Calculations.

The Number Out tab

Number Out Tab

Mathematical formulas are entered using the Number In and Point In values from the Controls tab. The output modifies the control in which the Expression was applied. See below for the syntax to use in this field.

The Point Out tab
Point Out Tab

The two text boxes in this tab use mathematical formulas, accessing the Number In and Point In values from the Controls tab. The output value modifies the control in which the Expression was applied. The Expression in the top text box control is used to calculate the X-axis value, and the bottom text box is used to calculate the Y-axis control. See below for the syntax to use in this field.

Config Tab

A good expression is reused over and over again. As a result, it can be useful to provide more descriptive names for each parameter or control and to hide the unused ones. The Config Tab of the Expressions modifier can customize the visibility and name for each of the nine point and number controls.

Random Seed

The Random Seed control sets the starting number for the Rand() function. The rand(x, y) function produces a random value between X and Y, producing a new value for every frame. As long as the setting of this Random Seed slider remains the same, the values produced at frame x are always the same. Adjust the Seed slider to a new value to get a different value for that frame.

Show Number or Point X

There are eighteen of these checkbox controls, one for each of the nine Number and nine Point inputs. Enable this checkbox to display the control for Number x or Point x in the Controls tab.

Name for Number or Point X

There are eighteen of these edit controls, one for each of the nine Number and nine Point inputs. Type a new name for the input into this edit control to assign a new name for the Input's label in the Controls tab.
### Expression Syntax Formulas

Formulas are entered into the Number Out or Point Out tabs as part of an expression. They can be made up of the following functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>n1...n9</td>
<td>The value of Number Input 1..9.</td>
</tr>
<tr>
<td>p1x...p9x</td>
<td>The X of Positional Control 1..9.</td>
</tr>
<tr>
<td>p1y...p9y</td>
<td>The Y of Positional Control 1..9.</td>
</tr>
<tr>
<td>time</td>
<td>The current time (frame number).</td>
</tr>
<tr>
<td>pi</td>
<td>The value of pi.</td>
</tr>
<tr>
<td>e</td>
<td>The value of e.</td>
</tr>
<tr>
<td>log(x)</td>
<td>The base-10 log of x.</td>
</tr>
<tr>
<td>ln(x)</td>
<td>The natural (base-e) log of x.</td>
</tr>
<tr>
<td>sin(x)</td>
<td>The sine of x (x is degrees).</td>
</tr>
<tr>
<td>cos(x)</td>
<td>The cosine of x (x is degrees).</td>
</tr>
<tr>
<td>tan(x)</td>
<td>The tangent of x (x is degrees).</td>
</tr>
<tr>
<td>asin(x)</td>
<td>The arcsine of x, in degrees.</td>
</tr>
<tr>
<td>acos(x)</td>
<td>The arccosine of x, in degrees.</td>
</tr>
<tr>
<td>atan(x)</td>
<td>The arctangent of x, in degrees.</td>
</tr>
<tr>
<td>atan2(x, y)</td>
<td>The arctangent of x,y, in degrees.</td>
</tr>
<tr>
<td>abs(x)</td>
<td>The absolute (positive) value of x.</td>
</tr>
<tr>
<td>int(x)</td>
<td>The integer (whole) value of x.</td>
</tr>
<tr>
<td>frac(x)</td>
<td>The fractional value of x.</td>
</tr>
<tr>
<td>sqrt(x)</td>
<td>The Square Root of x.</td>
</tr>
<tr>
<td>rand(x, y)</td>
<td>A random value between x and y.</td>
</tr>
<tr>
<td>rands(x, y, s)</td>
<td>A random value between x and y, based on seed s.</td>
</tr>
<tr>
<td>min(x, y)</td>
<td>The minimum (lowest) of x and y.</td>
</tr>
<tr>
<td>max(x, y)</td>
<td>The maximum (highest) of x and y.</td>
</tr>
<tr>
<td>dist(x1, y1, x2, y2)</td>
<td>The distance between point x1,y2 and x2,y2.</td>
</tr>
<tr>
<td>dist3d(x1,y1,z1,x2,y2,z2)</td>
<td>The distance between 3D points x1,y2,z1 and x2,y2,z2</td>
</tr>
<tr>
<td>noise(x)</td>
<td>A smoothly varying Perlin noise value based on x</td>
</tr>
<tr>
<td>noise2(x, y)</td>
<td>A smoothly varying Perlin noise value based on x and y</td>
</tr>
<tr>
<td>noise3(x, y, z)</td>
<td>A smoothly varying Perlin noise value based on x, y and z</td>
</tr>
<tr>
<td>if(c, x, y)</td>
<td>Returns x if c not 0, otherwise y.</td>
</tr>
</tbody>
</table>
**Expression Syntax Operators**

Operators are used to evaluate statements. They are combined with functions to perform logical and mathematical calculations in the Number Out and Point Out tabs.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>x + y</code></td>
<td><code>x</code> plus <code>y</code>.</td>
</tr>
<tr>
<td><code>x - y</code></td>
<td><code>x</code> minus <code>y</code>.</td>
</tr>
<tr>
<td><code>x &gt;= y</code></td>
<td>1.0 if <code>x</code> is less than <code>y</code>, otherwise 0.0.</td>
</tr>
<tr>
<td><code>x &gt; y</code></td>
<td>1.0 if <code>x</code> is greater than <code>y</code>, otherwise 0.0.</td>
</tr>
<tr>
<td><code>!x</code></td>
<td>1.0 if <code>x</code> = 0, otherwise 0.0.</td>
</tr>
<tr>
<td><code>+x</code></td>
<td><code>(0.0 - x)</code>.</td>
</tr>
<tr>
<td><code>x ^ y</code></td>
<td><code>x</code> raised to the power of <code>y</code>.</td>
</tr>
<tr>
<td><code>x y</code></td>
<td><code>x</code> multiplied by <code>y</code>.</td>
</tr>
<tr>
<td><code>x / y</code></td>
<td><code>x</code> divided by <code>y</code>.</td>
</tr>
<tr>
<td><code>x % y</code></td>
<td><code>x</code> modulo <code>y</code>, (remainder of <code>x</code> divided by <code>y</code>).</td>
</tr>
<tr>
<td><code>x &gt;= y</code></td>
<td>1.0 if <code>x</code> is less than or equal to <code>y</code>, otherwise 0.0.</td>
</tr>
<tr>
<td><code>x &lt;= y</code></td>
<td>1.0 if <code>x</code> is greater than or equal to <code>y</code>, otherwise 0.0.</td>
</tr>
<tr>
<td><code>x = y</code></td>
<td>1.0 if <code>x</code> is exactly equal to <code>y</code>, otherwise 0.0.</td>
</tr>
<tr>
<td><code>x == y</code></td>
<td>1.0 if <code>x</code> is exactly equal to <code>y</code>, otherwise 0.0 (identical to above).</td>
</tr>
<tr>
<td><code>x &lt;&gt; y</code></td>
<td>1.0 if <code>x</code> is not equal to <code>y</code>, otherwise 0.0 (identical to above).</td>
</tr>
<tr>
<td><code>x != y</code></td>
<td>1.0 if <code>x</code> is not equal to <code>y</code>, otherwise 0.0 (identical to above).</td>
</tr>
<tr>
<td><code>x &amp; y</code></td>
<td>1.0 if both <code>x</code> and <code>y</code> are not 0.0, otherwise 0.0.</td>
</tr>
<tr>
<td><code>x &amp;&amp; y</code></td>
<td>1.0 if both <code>x</code> and <code>y</code> are not 0.0, otherwise 0.0 (identical to above).</td>
</tr>
<tr>
<td>`x</td>
<td>y`</td>
</tr>
<tr>
<td>`x</td>
<td></td>
</tr>
</tbody>
</table>

**Example 1**

To make a numeric control equal to the Y value of a motion path, add an expression to the desired target control and connect the Path to Point In 1. Enter the formula:

\[ p1y \]

into the Number Out field.

**Example 2**

To make the result of the Expression’s Number Out be the largest of Number In 1 and Number In 2, multiplied by the cosine of Number In 3, plus the X coordinate of Point In 1, enter the formula:

\[ \text{max(n1, n2)} \times \cos(n3) + p1x \]

into the Number Out field.
Example 3

Add a Background node set to solid black and a Hotspot node. Set the Hotspot size to 0.08 and set the Strength to maximum. Modify the Hotspot center with an expression. Change the current frame to 0.

Set n1 to 0.0 and add a Bézier Spline. At frame 29, set the value of n1 to 1.0. Select both points and loop the spline using the Spline Editor. Now enter the following equations into the Point Out tab of the expression.

\[
\begin{align*}
\text{X-Axis Expression} \\
n1 \\
\text{Y-Axis Expression} \\
0.5 + \sin(\text{time}\times50) \\
\end{align*}
\]

Render out a preview and look at the results. (Try this one with motion blur.)

From Image

The From Image modifier only works on gradients, like the gradient on a Background node. It takes samples of an image along a user-definable line and creates a gradient from those samples.

Unlike other modifiers, From Image is not located in the Modify With menu. This modifier can be applied by right-clicking a Gradient bar in the Inspector and selecting From Image.

Inspector

Controls Tab

The From Image controls tab in the Inspector is used to select the node that contains the image you want to sample. It allows you to define the starting and ending point in the image as well as how many color samples to use in creating the gradient.

Image to Scan

Drop into this box the node from the Node Editor that you want to be color sampled.

Start X/Y, End X/Y

These two point controls define the Start and End points of the line along which the samples are taken from the image defined in the Image to Scan box.

The points can also be moved directly in the viewer.
**Number of Sample Steps**
This defines how many individual color samples are taken along the line. You can also see the result of this setting when you look at the actual node’s Gradient control. The more sample steps you define here, the more individual color stops appear on the Gradient control. It is also possible to first create a gradient using the From Image modifier and then remove that modifier from the Gradient control again. The created gradient stays intact and can then be fine tuned by hand.

**Edges**
Edges determines how the edges of the image are treated when the sample line extends over the actual frame of the image to be sampled.

**Black**
This outputs black for every point on the sample line outside of the image bounds.

**Wrap**
This wraps the edges of the line around the borders of the image.

**Duplicate**
This causes the edges of the image to be duplicated as best as possible, continuing the image beyond its original size.

**Color**
This outputs a user-definable color instead of black for every point on the sample line outside of the image bounds.

**Example**

![Example Image]

The source image on the left shows the color selection line in red. The image on the right shows the resulting gradient from that selection.

**Gradient Color**
The Gradient Color modifier allows you to create a customized gradient and map it into a specific time range to control a value. Use the Start and End time controls to set the frames for the animation. If the Start and End time values are set to 0, then the modifier returns the value at the starting point of the gradient. You can use the Offset control to animate the gradient manually.

It can be applied by right-clicking a parameter and selecting Modify With > Gradient Color.
Controls Tab

The Controls tab consists of a Gradient bar where you add and adjust points of the gradient. Start Time and End Time thumbwheels at the bottom of the Inspector determine the time range the gradient is mapped into.

Gradient

The Gradient control consists of a bar where it is possible to add, modify, and remove points of the gradient. Each point has its color. It is possible to animate the color as well as the position of the point. Furthermore, a From Image modifier can be applied to the gradient to evaluate it from an image.

Gradient Interpolation Method

The gradient is linearly interpolated from point to point in RGB color space by default. This can sometimes result in unwanted colors. Choosing another color space may provide a better result.

Repeat

Defines how the left and right borders of the gradient are treated.
– **Once:** When using the Gradient Offset control to shift the gradient, the border colors keep their values. Shifting the default gradient to the left results in a white border on the left; shifting it to the right results in a black border on the right.

– **Repeat:** When using the Gradient Offset control to shift the gradient, the border colors are wrapped around. Shifting the default gradient to the left results in a sharp jump from white to black; shifting it to the right results in a sharp jump from black to white.

– **Ping Pong:** When using the Gradient Offset control to shift the gradient, the border colors ping pong back and forth. Shifting the default gradient to the left results in the edge fading from white back to black; shifting it to the right results in the edge fading from black back to white.

**Gradient Offset**

Allows you to pan through the gradient.

**Time Controls**

The Start Time and End Time thumbwheels determine the time range the gradient is mapped into. This is set in frames. The same effect can be achieved by setting the Gradient to Once and animating the offset thumbwheel.

**Key Stretcher Modifier**

The Keyframe Stretcher modifier is primarily used when creating title templates in Fusion for use in DaVinci Resolve’s Edit page or Cut page. The Keyframe Stretcher modifier is added to an animated parameter, so the keyframes in the animated parameter stretch when the template is trimmed in the Timeline. It can be applied by right-clicking a parameter and selecting Modify with > KeyStretcher.

For more information on the Keyframe Stretcher Modifier controls, see the Keyframe Stretcher Node in Chapter 49, “Miscellaneous Nodes” in the Fusion Reference Manual or Chapter 110 in the DaVinci Resolve Reference Manual.

**MIDI Extractor**

The MIDI Extractor modifier provides the ability to modify the value of a control using the values stored in a MIDI file. This modifier relies on some knowledge of MIDI, which is beyond the scope of this manual.

The value produced by the modifier is extracted from the MIDI event selected in the Mode menu. Each mode can be trimmed so that only specific messages for that event are processed—for example, only some notes are processed, while others are ignored. The value of the event can be further scaled or modified by additional factors, such as Scale, Velocity, Attack, and Decay.

It can be applied by right-clicking a parameter and selecting Modify With > MIDI Extractor.
Inspector

Controls Tab
The Controls tab is used to load the MIDI file, modify its timing, and determine which MIDI messages and events trigger changes in the Fusion parameter.

MIDI File
This browser control is used to specify the MIDI file that is used as the input for the modifier.

Time Scale
Time Scale is used to specify the relationship between time as the MIDI file defines it and time as Fusion defines it. A value of 1.0 plays the MIDI events at normal speed, 2.0 plays at double speed, and so on.

Time Offset
Time Offset adjusts the sync between the MIDI file’s timing and Fusion’s timing. If there is an unexpected delay, or if the MIDI file should start partway into or before some animation in Fusion, this control can be used to offset the MIDI data as required.

Result Offset, Result Scale
These sliders adjust the range of values produced by the modifier. By default, values between 0 and 1 (or -1 and 1 for PitchBend mode) are generated. This does not always suit the node/parameter, and scale can be used to make this range larger (such as * 0.0 - 2.0). Offset is used to provide some constant value as a base.
Result Curve
The Result Curve can also be used to adjust the output. However, this adjusts the curve of the result. By default, for any input MIDI data, the results fall linearly between 0.1 and 1.0 (for example, a velocity 127 note generates 1.0, whereas 63 generates approximately 0.5).

The Result Curve applies a gamma-like curve so that middle values can produce higher or lower results while still maintaining the full scale.

Mode
This menu provides Beat, Note, Control Change, Poly AfterTouch, Channel AfterTouch, or Pitch Bend, indicating from which MIDI event the values are being read. Beat mode is slightly different in that it produces regular pulses based on the tempo of the MIDI file (including any tempo maps).

The Beat mode does not use any specific messages; it bases its event timing on the tempo map contained in the MIDI file.

Combine Events
This menu selects what happens when multiple events occur at the same time. In Notes mode, this can happen easily. For other events, this can happen if Multiple Channels are selected.
Use this to take the result from the most recent event to occur, the oldest event still happening, the highest or lowest valued event, the average, sum, or the median of all events currently occurring.

Beat (Quarters) (Beat Mode Only)
This defines how often a beat occurs when in Beat mode. This is in quarter notes, so a value of 1.0 gives a beat every quarter.

Note Range (Note and Poly Aftertouch Modes Only)
This defines what range of notes causes a value to be generated. For example, use this to pick out the kick drum from a GM drum track by setting the note range between 35–36.

Pitch Scale (Note Mode Only)
Pitch Scale defines how much the result changes with pitch. A value of 1.0 causes the result to vary from 0.0 to 1.0 over the entire range.

Velocity Scale (Note Mode Only)
This defines how much the result changes with velocity. A value of 1.0 causes the result to vary from 0.0 to 1.0 over the entire range. This is added to the result from Pitch Scale for the final result.

Control Number (Control Change Mode Only)
This specifies the MIDI controller number from which to extract events.

Envelope Controls (Note and Beat Modes Only)
These define an Envelope to follow for values before, during, and after the note or beat. Pre-Attack Time defines how long before the event it starts ramping up to the pre-attack level. Attack is the Time/Level to ramp to once the event has occurred, followed by the Decay ramp and Sustain, until the event stops. This stage is for Notes only. Beats have an instantaneous duration, so it goes straight to Release. Release is the ramp-down time after the event finishes. When trying to do a Beat, set Release to some value, or there likely will not be much of a beat.

These values can be used to follow actual sounds in the MIDI sequence or just to create interesting effects. All time values used in the MIDI Extractor are in seconds.
Channels Tab

The Channels tab is used to select the Channels used in the modifier.

Channels

Channels checkboxes select which of the 16 channels in the MIDI file are actually considered for events. This is a good way to single out a specific instrument from an arrangement.

About MIDI

A single MIDI interface allows 16 channels. Typically, these are assigned to different instruments within a device or different devices. Usually, MIDI data is 7 bits, ranging from 0–127. In Fusion, this is represented as a value between 0–1 to be more consistent with how data is handled in Fusion.

There are numerous different MIDI messages and events, but the ones that are particularly useful with this modifier are detailed below.

MIDI Messages

- **Note On**: This indicates that a note (on a specific channel) is being turned on, has a pitch (0–127, with middle C being 60) and a Velocity (0–127, representing how fast the key or strings or whatever was hit).

- **Note Off**: This indicates that a note (on a specific channel) is being turned off, has a pitch (0–127, with middle C being 60) and a Velocity (0–127, representing how fast the key or strings or whatever was released).

- **Control Change**: This message indicates that some controller has changed. There are 128 controllers (0–127), each of which has data from 0–127. Controllers are used to set parameters such as Volume, Pan, amount of Reverb or Chorus, and generic things like foot controllers or breath controllers.

MIDI Events

- **Channel Aftertouch**: This event defines that pressure is being applied to the keys (or strings or whatever) during a note. This represents general, overall pressure for this channel, so it simply uses a pressure value (0–127).

- **Poly Aftertouch**: This event defines that pressure is being applied to the keys (or strings or whatever) during a note. It is specific to each particular note and therefore contains a note number as well as a pressure value (0–127).

Pitch Bend

The Pitch Bend controller generally specifies the degree of pitch bending or variation applied to the note. Because pitch bend values are transmitted as a 14-bit values, this control has a range between -1 and 1 and a correspondingly finer degree of resolution.
Natural Cubic Spline

The Natural Cubic Spline is one of the animation modifiers in Fusion and normally is applied to numerical values rather than point values. It can be applied by right-clicking a numerical control and selecting Modify With > Natural Cubic Spline.

**NOTE:** Unlike other spline types, Cubic splines have no control handles. They attempt to automatically provide a smooth curve through the control points.

Usage

Being an animation spline, this modifier has no actual Controls tab. However, its effect can be seen and influenced in the Spline Editor.

Offset (Angle, Distance, Position)

There are three Offset modifiers used to create variances between values. Depending on the modifier, these values relate to controls, paths, and points. The three types of Offset modifiers available in Fusion are:

- Offset Angle
- Offset Distance
- Offset Position

**Offset Angle**

The Offset Angle modifier outputs a value between 0 and 360 that is based on the angle between two positional controls. The Position and Offset parameters may be static, connected to other positional parameters, or connected to paths of their own. All offsets use the same set of controls, which behave differently depending on the offset type used. These controls are described below.

**Offset Distance**

The Offset Distance modifier outputs a value that is based on the distance between two positional controls. This modifier is capable of outputting a value based on a mathematical expression applied to a position.
Offset Position

The Offset Position modifier generates a position (X and Y coordinates) that is based on the relationship between positional controls. This modifier is the equivalent of a calculation control except that it outputs X and Y coordinates instead of a value.

It can be applied by right-clicking a control and selecting Modify With > Offset.

Inspector

The Offset Position modifier controls

Offset Tab

The Inspector for all three Offset modifiers is identical. The Offset tab includes Position and Offset values as well as a Mode menu for selecting the mathematical operation performed by the offset control.

Position X and Y

The X and Y values are used by the Position to generate the calculation.

Offset X and Y

The X and Y values are used by the Offset to generate the calculation.

Flip Position Horizontal and Vertical

When these controls are selected, the Position is mirrored along the vertical or horizontal axis of the image.

Flip Offset Horizontal and Vertical

When these controls are selected, the Offset position is mirrored along the vertical or horizontal axis of the image.

Mode

The Mode menu includes mathematical operations performed by the Offset control. Available options include:

- Offset
- Difference (Position - Offset)
- Difference (Offset - Position)
- Average
- Use Position Only
- Use Offset Only
- Maximum
- Minimum
- Invert Position
- Invert Offset
- Invert Sugar
- Random Offset
Image Aspect
Adjust the modifier’s output to compensate for the image aspect (not pixel aspect) of the project. A square image of 500 x 500 would use an Image Aspect value of 1, and a rectangular image of 500 x 1000 would use an Aspect Value of 2. The default value is always based on the current frame format selected in the preferences. To calculate image aspect, divide the width by the height. This control can also be used to create the illusion of aspect.

Time Tab

Position Time Scale
This returns the value of the Position at the Time Scale specified (for example, 0.5 is the value at half the current frame time).

Position Time Offset
This returns the value of the Position at the Time Offset specified (for example, 10 is 10 frames back).

Offset Time Scale
This returns the value of the Offset at the Time Scale specified.

Offset Time Offset
This returns the value of the Offset at the Time Offset specified.

Example
This is a simple comp to illustrate one potential use of offsets.

1. Create a new Comp 100 frames long.
2. Create a node tree consisting of a black background and a Text node foreground connected to a Merge.
3. In the Text Layout tab, use the Center X control to animate the text from the left side of the screen to the right.
4. Move to frame 0.
5. In the Text tab in the Inspector, right-click the Size control and select Modify With > Offset Distance from the contextual menu.

This adds two onscreen controls: a crosshair for the position and an X control for the offset. These onscreen controls represent the Position and Offset controls displayed in the Modifiers tab.

The size of the text is now determined by the distance, or offset, between the two onscreen controls.

6. Drag the X onscreen control in the viewer to see how the distance from the crosshair changes the size of the merge and by association the text.
Both the crosshair and the X onscreen controls are animatable and can be connected to other controls.

7 Position the X centered at the bottom of the viewer.

8 In the Inspector, select the Modifiers tab.

9 In the Offset on Text size section, right-click over Position and choose Connect To > Path. Connect the position value of the Offset to the existing path by right-clicking the Position control and selecting Connect To > Path1 Position.

Play the comp to view the animation.

10 Now, the text shrinks near the center of the path (when the distance between the offset and the path is at its minimum) and grows at its ends (where the distance between the offset and the path is at its maximum).

Path

The Path modifier uses two splines to control the animation of points: an onscreen motion path (spacial) and a Time spline visible in the Spline Editor (temporal). To animate an object’s position control using a Path, right-click the Position control either in the Inspector or in the viewer and select Path from the contextual menu. This adds a keyframe at the current position. You can begin creating a path by moving the playhead and dragging the center position control in the viewer. The Spline Editor shows a displacement spline for editing the temporal value, or “acceleration,” of the path.

Controls

The Path modifier Controls tab

Controls Tab

The Controls tab for the path allows you to scale, reposition, and rotate the path. It also provides the Displacement parameter, allowing you to control the acceleration of an object attached to the path.

Center

The actual center of the path. This can be modified and animated as well to move the entire path around.

Size

The size of the path. Again, this allows for later modification of the animation.
**X Y Z Rotation**

The path can be rotated in all three dimensions to allow for sophisticated controls.

**Displacement**

Every motion path has an associated Displacement spline in the Spline Editor. The Displacement spline represents the position of the animated element along its path, represented as a value between 0.0 and 1.0. Displacement splines are used to control the speed or acceleration of an object’s movement along the path.

To slow down, speed up, stop, or even reverse the motion of the control along the path, adjust the values of the points for the path’s displacement in the Spline Editor or in the Inspector.

- A Displacement value of 0.0 in the Spline Editor indicates that the control is at the very beginning of a path.
- A value of 1.0 indicates that the control is positioned at the end of the path.
- Each locked point on the motion path in the viewer has an associated point on the Displacement spline.
- Unlocked points have a control point in the viewer but do not have a corresponding point on the Displacement spline.

**Heading Offset**

Connecting to the Heading adjusts the auto orientation of the object along the path. For instance, if a mask’s angle is connected to the path’s heading, the mask’s angle will adjust to follow the angle of the path.

**Right-Click Here for Shape Animation**

It’s possible to animate the shape of the path as well or to connect it to other path controls like Polyline Masks or Paint Strokes.

**TIP: Switching Default Paths**

You can change the default path type used when animating a position or center control to a path (if this is the preferred type of animation). Open the Preferences window and select the Global Settings. In the Default category, select the Point With menu and choose Path. The next time Animate is selected from a Position or Center control’s contextual menu, a path is used.

**Perturb**

The Perturb modifier generates smoothly varying random values for a given parameter based on Perlin noise. It can be used to add jitter, shake, or wobble to any animatable parameter, even if the parameter is already animated. Its results are similar to those of the Shake modifier, although it uses a different set of controls that may be more intuitive. Unlike other random modifiers, you can apply the Perturb modifier to polylines, shapes, grid meshes, and even color gradients.

For example, to add camera shake to an existing path, right-click the crosshair and choose Insert > Perturb, and then adjust the Strength down to suit. Alternatively, right-clicking the path’s “Right-click here for shape animation” label at the bottom of the Inspector lets you apply perturb to the path’s polyline. This works best if the polyline has many points—for example, if it has been tracked or hand-drawn with the Draw Append pencil tool. A third usage option is to use the Insert contextual menu to insert the modifier onto the Displacement control. This causes the motion along the path to jitter back and forth without actually leaving the path.
NOTE: Perturb can only add jitter; it cannot smooth out existing animation curves.

Inspector

The Perturb modifier Controls tab

Controls Tab

The Controls tab for Perturb is mainly used for controlling the Strength, Wobble, and Speed parameters of the random jitter.

Value

The content of this control depends on what type of control the modifier was applied to. If the Perturb modifier was added to a basic Slider control, the Value is a slider. If it was added to a Gradient control, then a Gradient control is displayed here. Use the control to set the default, or center value, for the Perturb modifier to work on.

The Perturb modifier Gradient controls
Jaggedness
(Polylines and meshes only) This allows you to increase the amount of variation along the length of the polyline or mesh, rather than over time. Increasing Jaggedness gives a squigglier polyline or more tangled mesh, independent of its movement.

Phase
(Polylines and meshes only) Animating this can be used to move the ripple of a polyline or mesh along itself, from end to end. The effect can be most clearly seen when Speed is set to 0.0.

Random Seed Randomize
The Random Seed is used to "seed" the amount of jitter applied by the modifier. Two Perturb modifiers with identical settings, but different random seeds, produce two completely different results. Click the Randomize button to assign a random seed value.

Strength
Use this control to adjust the strength of the Perturb modifier’s output, or its maximum variation from the primary value specified above.

Wobble
Use the Wobble control to determine how smooth the resulting values are. Less wobble implies a smoother transition between values, while more wobble produces less predictable results.

Speed
Increasing the Speed slider value speeds up the rate at which the value changes. This can increase the apparent wobbliness in a more predictable fashion than the Wobble control and make the jitter more frantic or languorous in nature.

Probe
The Probe modifier is one of the most versatile modifiers in Fusion. It allows you to control any numeric parameter by the color or luminosity of a specific pixel or rectangular region of an image. Think of driving the Brightness node by probing the pixel values of flickering lights in a shot, or measuring graded LUTs to compare values.

It can be applied by right-clicking a parameter and selecting Modify With > Probe.

Inspector

The Probe modifier Controls tab

Controls Tab
The Controls tab for the Probe modifier allows you to select the node to probe, define the channel used to drive the parameter, and control the size of the probed area.

Image to Probe
Drag a node from the Node Editor to populate this field and identify the image to probe.
**Channel**
Select the channel you want to probe. The usual options are:
- Red
- Green
- Blue
- Alpha

**Luma**
Once a Probe modifier is present somewhere in your comp, you can connect other node’s values to its outputs as well. The Probe allows you to connect to its values individually:
- Result
- Red
- Green
- Blue
- Alpha

**Position X Y**
The position in the image from where the probe samples the values.

**Probe Rectangle**
By default, the Probe samples only the value of a single pixel at its position. By using the Probe Rectangle mode, you can sample from a larger area of pixels based on the Evaluation method.

**Width Height Controls**
These determine the size of the area to be probed.

**Evaluation**
Sets how the pixels inside the rectangle are computed to generate the output value.

Options include:
- **Average**: All pixel values inside the rectangle are averaged.
- **Minimum**: The smallest value of all pixels inside the rectangle is used.
- **Maximum**: The highest value of all pixels inside the rectangle is used.

![The Probe modifier Value tab](image)

**Value Tab**
The Value tab controls the range or scale of the modifier adjustment, thereby adjusting the sensitivity of the Probe.
Scale Input
By default, the Probe generates the Black Value when the probed area results in a value of 0 (i.e., black), and it generates its White Value when the probed area results in a value of 1 (i.e., white). By using this range control, you can modify the sensitivity of the Probe.

Black Value
The value that is generated by the Probe if the probed area delivers the result set in Scale Input Black.

White Value
The value that is generated by the Probe if the probed area delivers the result set in Scale Input White.

Out of Image Value
The value that is generated by the Probe if the probed area is outside the frame boundaries of the probed image. If probing a rectangle, this value does not generate before the entire rectangle is outside the frame boundaries of the image to be probed.

Publish
Only parameters that are animated will be available from the Connect To menu. To connect to non-animated parameters, you must Publish them first. Animated controls are automatically published, whereas static controls must be published manually.

To publish a static control, right-click the control and select Publish from the contextual menu.

The Publish modifier Controls tab

Controls Tab
The Controls tab shows the published control available for linking to other controls.

Published Value
The display of the published control is obviously dependent on which control is published from which node.

Resolve Parameter
The Resolve Parameter Modifier is used when creating a transition template in Fusion for use in DaVinci Resolve’s Edit page or Cut page. When building a transition in Fusion, the Resolve Parameter modifier is added to any control you want to animate. The Resolve Parameter modifier automatically animates the parameter for the duration of the transition, allowing you to trim the transition in the Edit page or Cut page.
For example, to create a cross dissolve, do the following:

1. From the Effects Library, add a Fusion Composition to the Edit page Timeline.
2. In Fusion, add a Dissolve node to the Node Editor.
3. In the Inspector, right-click the Background/Foreground parameter, and then choose Resolve Parameter from the Modifier contextual menu. Adding the modifier to the Background/Foreground parameter automatically updates the slider if the transition is modified back on the Edit/Cut page.
4. In the Node Editor, right-click the Dissolve node and choose Macro > Create Macro.
5. When creating a macro that’s to be used as a Fusion transition it’s important that two inputs and one output are selected in the Macro Editor. In this example, under the Dissolve heading, enable the Output, Background and Foreground check boxes.
6. Give the transition a name, then save the macro from the top File menu.
7. Save the macro in the following folder so it appears the Edit page or Cut page Effects Library:
   - **For MacOS:** `$TEMPLATE_MAC_OS_PATH/Transitions` or `$TEMPLATE_MAC_USER_PATH/Transitions`
   - **For Windows:** `$TEMPLATE_WIN_OS_PATH\Transitions` or `$TEMPLATE_WIN_USER_PATH\Transitions`
8. Quit and reopen DaVinci Resolve to update the list of transitions in the Effects Library.
9. On the Edit page, open the Effects Library. Navigate to Video Transitions Fusion Transitions, and the custom Fusion transition will be listed.

**Shake**

The Shake modifier is used to randomize a Position or Value control to create semi-random numeric inputs. The resulting shake can be entirely random. The motion can also be smoothed for a more gentle, organic feel.

To add the Shake modifier to a parameter, select Modify With > Shake from the parameter’s contextual menu. The Shake modifier uses the following controls to achieve its effect. It can be applied by right-clicking a parameter and selecting Modify With > Shake.

**Inspector**

![The Shake modifier Controls tab](Image)
Controls Tab

Random Seed
The Random Seed control contains the value used to seed the random number generator. Given the same seed, a random number generator always produces the same results. Change the seed if the results from the randomizer are not satisfying.

Smoothness
This control is used to smooth the overall randomness of the Shake. The higher the value, the smoother the motion appears. A value of zero generates completely random results, with no smoothing applied.

Lock X/Y
This checkbox is used to unlock the X- and Y-axis, revealing independent slider controls for each axis.

Minimum and Maximum
This control is used to determine the overall strength of the shake. The low values represent the lowest value that can be generated by the randomizer, and the high values represent the highest values. To create a Shake that moves a center crosshair anywhere within the image, set the Minimum to 0.0 and the Maximum to 1.0. To restrict the motion to a smaller shake in the bottom-right corner of the image, set the Minimum to 0.70 and the Maximum to 0.90.

Example
1. Create a new comp, and then add and view a Text node.
2. Type some text in the Text node.
3. In the viewer, right-click over the Center control of the text and choose Modify With > Shake Position.
4. In the Inspector, select the Modifiers tab and set the smoothing to 5.0.
5. Set the Minimum to 0.1 and the Maximum to 0.9.
   This adds some chaotic movement to the text. However, we can change this over Go to frame 0 and in the Inspector click the Keyframe button to the right of both the Minimum and the Maximum controls.
6. Go to frame 0 and in the Inspector click the Keyframe button to the right of both the Minimum and the Maximum controls.
7. Go to frame 90 and adjust the Minimum to 0.45 and the Maximum to 0.55.
8. View the results.

Now, the text starts out by flying all over the screen and tightens in toward the center of the screen as the comp plays.
Track

Although there is a standard Tracker node, you can also use a Tracker modifier to add a tracker directly to a parameter. To apply the Tracker modifier, in the viewer right-click the Center control of any transform, text, mask, or other positionable element. From the contextual menu, choose Object x Center > Modify With > Tracker. Then choose one of three options:

- **Tracker Position**: Tracks a point from the source.
- **Steady Position**: Stabilizes based on a single point in the source.
- **Unsteady Position**: Adds original motion back after stabilizing.

This adds a modifier in the Inspector with a set of controls almost identical to those found in the Tracker node itself.

Inspector

![The Tracker modifier](image)

For an in-depth explanation of this node, see Chapter 57, “Tracker Nodes” in the Fusion Reference Manual or Chapter 118 in the DaVinci Resolve Reference Manual.

**Tracker Modifier vs. Tracker Node**

The differences between a Tracker modifier and a Tracker node are as follows:

- The Tracker modifier can only track a single pattern.
- The Tracker modifier can only output a single value and cannot be used for complex stabilization or match-moving procedures.
- The default source image for the modifier is the node immediately upstream of the node that contains the modifier (i.e., when adding a Tracker modifier to a Glow node with a Loader as its input, the Tracker Source input defaults to the output of the Loader). Set a different source image for the Tracker modifier by typing in the name of the node. Alternatively, drag the source node from the Node Editor into the Text Box control.
Example
Imagine that you need to track an actor’s eyes so that an unearthly, alien glow can be applied to the eyes.

1. Select the Loader node.
2. Add a Glow node.
3. Add an Ellipse mask to the Glow in the shape of one of the eyes.
4. Right-click the center of that mask and select Modify With > Tracker > Position.
   Since the track is on the mask, the tracker takes the glow as the image for tracking. This could cause problems since the eye might be very obscured by the glow. A cleaner source will be the Loader that feeds the glow.
5. Drag the Loader into the modifier Inspector’s Track Source field.
6. Track the actor’s eye.
7. Perform the same steps on the other eye.

Vector Result
The Vector Result modifier is used to offset positional controls, such as crosshairs, by distance and angle. These can be static or animated values.

It can be applied by right-clicking a control and selecting Modify With > Vector.

Inspector

Controls Tab
- **Origin**
  This control is used to represent the position from which the vector’s distance and angle values originate.

- **Distance**
  This slider control is used to determine the distance of the vector from the origin.

- **Angle**
  This thumbwheel control is used to determine the angle of the vector relative to the origin.
Image Aspect
This slider control is used primarily to compensate for image aspect differences. A square image of 500 x 500 would use an Image Aspect value of 1, while a rectangular image of 500 x 1000 would use an Image Aspect value of 2. The default for this value is taken from the current Frame Format preferences using width/height. It may be necessary to modify this control to match the current image.

Example
1. Create a 100-frame comp.
2. Create a simple node tree consisting of a black background and a Text node foreground connected to a Merge.
3. Enter some text in the Text node.
4. Select the Merge node.
5. In the viewer, right-click the Center control of the Merge and choose Modify With > Vector Result.
   This adds a crosshair onscreen control for the Vector distance and angle. The onscreen control represents the Distance and Angle controls displayed in the Modifiers tab.
6. In the Modifiers tab of the Inspector, drag the Distance control to distance the text from the Vector origin.
7. Drag the Angle thumbwheel to rotate the text around the Vector origin.
   This is different from changing a pivot point, since the text itself is not rotating.
   These points are animatable and can be connected to other controls.
8. In the Inspector, right-click the Origin control and choose a path to add a motion path modifier to the Origin control.
9. Verify that the current frame is set to frame 0 (zero) and use the Origin controls in the Inspector or drag the Vector Origin crosshair to the bottom-left corner of the screen.
10. On the Vector Angle thumbwheel, click the Keyframe button to animate this control.
11. Set the Angle thumbwheel to a value of 10.
12. Go to frame 100 and click at the top-left corner of the screen to move the Vector Origin crosshair.
13. Set the Vector Angle thumbwheel to a value of 1000.
14. Play the comp to see the results.
   This causes the text to orbit around the path just created.

XY Path
The XY Path type uses two separate splines for the position along the X-axis and for the position along the Y-axis.

To animate a coordinate control using an XY path, right-click the control and select Modify With > XY Path from the contextual menu.

At first glance, XY paths work like Displacement paths. To describe the path, change frames and position the control where it should be on that frame, and then change frames again and move the control to its new position. Fusion automatically interpolates between the points. The difference is that no keyframes are created on the onscreen path.
Look in the Spline Editor to find the X and Y channel splines. Changes to the control’s values are keyframed on these splines. The advantage to the XY path is that it becomes very easy to work with motion along an individual axis.

**Inspector**

**X Y Z Values**
These reflect the position of the animated control using X, Y, and Z values.

**Center**
The actual center of the path. This can be modified and animated as well to move the entire path around.

**Size**
The size of the path. Again, this allows for later modification of the animation.

**Angle**
The angle of the path. Again, this allows for later modification of the animation.

**Heading Offset**
If another control (for example, a mask’s Angle) is connected to the path’s heading, this control allows for adding or subtracting from the calculated angle.

**Plot Path in View**
Toggles whether or not the actual path is displayed in the views.

**Switching Default Paths**
You can change the Default Path type to XY path (if this is the preferred type of animation). Open the Default category in the Global Preferences and locate the Point With drop-down menu. Change this from the current value to XY Path. The next time Animate is selected from a Coordinate control’s contextual menu, an XY path is used instead of a Displacement path.
PART 10

Color
Chapter 123

Introduction to Color Grading

For over thirty years, DaVinci has pioneered the development of color correction hardware and software designed to enhance visual images acquired from film and video. This release of DaVinci Resolve possesses our newest and most evolved professional color correction tools yet. However, for all its technological sophistication, DaVinci Resolve is merely a tool that requires the hands of a skilled artist to realize its full potential.

Subsequent chapters of this user manual cover the DaVinci Resolve grading tools in the Color page in great detail, but before getting into the specifics of color balancing and contrast adjustment, Power Windows, and Custom Curves, it's important to step back and consider what these tools are for, and why you're learning to use this application in the first place.

This introduction is for those of you who are new to this process we call color correction, or color grading. If you’re a veteran colorist then you might want to skip ahead, but if you’re just starting out, the following sections are intended to describe the many goals of color correction, and how the DaVinci Resolve toolset has been designed to address them; making it fast and efficient to alter images in innumerable ways as we elevate raw footage to cinematic art.

Contents

The Goals of Color Correction 2487
Maximizing the Look of Your Media 2487
Emphasizing What’s Important 2489
Audience Expectations 2490
Balancing Scenes 2492
Adding Style 2493
Quality Control 2495
Never Stop Experimenting 2496
The Goals of Color Correction

If reality is a fire hose of visual information, then digital cinema and broadcast would be represented by a garden hose. Color correction, therefore, could be considered the process of choosing which parts of the fire hose of raw image data to fit into the garden hose of our displays in order to create a pleasing image for the viewer.

Maximizing the Look of Your Media

Clearly, the most fundamental aspect of the color correction process is that of making every clip look its best. While the job of the cinematographer is to light and expose the image with an artistic intent, your job is to realize this intent by making adjustments to the color and contrast of the image, so that the final result is as close to what the director and cinematographer had in mind as is humanly possible. In the process, you have the opportunity to overcome inconsistencies with exposure and white balance that were, for various reasons, unavoidable. Furthermore, you can make subtle adjustments to add warmth or contrast that was not available during the shoot, but that the cinematographer would have liked.

Increasingly, color correction is seen as a critical stage in the post-production process. For example, the newer generation of digital cinema cameras are capable of shooting raw colorspace image data, or RGB image data with a log exposure, in order to preserve the maximum amount of image data for manipulation during the color correction process. However, when you acquire image data this way, it must be transformed into a viewable image via color correction in the same way that film negative must first be developed and printed to positive film.

Of course, there are also situations in which you may find it necessary to attempt to fix source media with far more substantial problems in color and exposure. In these cases, the tools exist to make far more involved adjustments to the image; however, the quality of your results will depend heavily on the data quality and “latitude” of your source media.

For example, Blackmagic URSA, ARRI ALEXA, and RED DRAGON cameras record quite a bit of image data, making extreme corrections far more possible than more heavily compressed camera formats such as the Canon 5D. However, in either case, DaVinci Resolve provides the tools to process images in many different ways to adjust the image for a better look.
Whether clips need changes large or small, the primary DaVinci Resolve toolset adjusts the characteristics of hue, saturation, and contrast in a variety of ways. In the Color Wheels palette, Color balance wheels let you adjust all three color channels at once, altering the color temperature of the scene at specific ranges of tonal detail referred to as lift, gamma, and gain. Alternately, the slider-based Primaries Bars mode lets you make the same kinds of controls via independently adjustable red, green, and blue lift, gamma, and gain controls.

All of these controls let you adjust the color tone of the shadows, midtones, and highlights independently from each other.
Meanwhile, the Master Lift, Gamma, and Gain wheels work together to let you alter image contrast in different ways: deepening shadows, lightening highlights, and brightening or darkening the midtones in between to create whatever image tonality you prefer for a given scene.

Separate saturation controls let you increase or decrease color intensity throughout the scene, while the Lum vs. Sat and Sat vs. Sat curves give you the ability to fine-tune saturation very specifically.

For more information on these controls, which are essential to the color correction process, see Chapter 129, "Primaries Palette."

**Emphasizing What’s Important**

Another important aspect of the color correction process is the ability to make adjustments to emphasize or de-emphasize specific elements within the frame. It’s similar in concept to equalization in audio mixing, in that you’re choosing which color values to boost or suppress using a variety of techniques.

This can be done to direct the viewer’s gaze, for example by surrounding a specific part of the image with a window, which lets you restrict specific adjustments made to the inside and outside of the window’s shape.
Specific alterations can also be made to prevent audience distraction. For example, a low-saturation monochromatic tint may be a pleasing look overall, but in the soft wash of color, the viewer might lose track of the watch that’s preoccupying the protagonist. Using tools such as the Hue curves and HSL Qualifier, you can quickly and easily tune the color of the woman’s hands and of the watch to guide the viewer’s eye, and bring some needed depth to the scene.

For more information on Power Windows, see Chapter 135, “Secondary Windows and Tracking.” For more information on Hue curves, see Chapter 132, “Curves.”

**Audience Expectations**

There is another family of tools, the HSL, RGB, and Luma Qualifiers, that provide even more specific control, and they’re useful for adjusting ranges of color to either play into or against the audience expectations for color in a scene. Substantial research into what has been termed “memory color” shows that people have finely tuned expectations for the hues of particular subjects, such as flesh tone, foliage greens, and sky blues. Deviation from these expectations can create a sense of something being not quite right, which can be either detrimental or beneficial, depending on your goals for a particular scene.
HSL Qualification is effectively a chroma keyer that lets you sample the image to create a key that’s used to define where to apply a specific correction. For example, if you’re happy with the rest of the image, but the skin tone of the actor has an unhealthy green tinge to it as a result, you can isolate the color of that actor’s skin and adjust it to a healthier hue.

Source Image

Skin now has warmer grade

Another common example is the adjustment of skies. If you’re aiming for a gorgeous summer day, a washed out sky in the source media can be a bit of a bummer. However, using qualification it’s easy to isolate that wedge of blue, then push and pull it into just the right amount of summertime joy.

Originally graded scene

Corrected and sky enhanced

For more information on using qualifiers, see Chapter 134, "Secondary Qualifiers."
Balancing Scenes

It’s rare when the uncorrected shots of a scene match one another perfectly. Even the most carefully exposed angles of coverage can have small variances that need to be evened out. On the other end of the spectrum, run-and-gun programs using available light often result in edited scenes with huge changes in lighting and color as each shot cuts away to the next.

Small or large, unintended variations from one shot to the next can call undue attention to the editing, and jar the audience’s attention in ways that throw them out of the program. Evening out these differences and balancing the clips in each scene to match is another of the fundamental tasks of the colorist. You know you’re finished when the color in the scene flows unnoticeably from one clip to the next.

DaVinci Resolve has a variety of tools that you can use to help you compare images with one another, the most important of which is the Gallery, in which you can save still images of clips that you can then compare to other clips using an adjustable split screen.

By using the Gallery to play stills, either split or whole (flipping back and forth between the clip you’re adjusting and the still), it becomes easier to use the extensive DaVinci Resolve toolset to match the color and exposure of every clip in a scene.

An additional set of features let you manage grades by copying them from clip to clip, or by linking similar clips, either automatically, or manually using groups.
For more information on using the Still Store, see Chapter 124, “Using the Color Page.” For more information on grade management, see Chapter 139, “Grade Management.”

**Adding Style**

Of course, it’s not all about subtlety and correction. It’s often appropriate, when grading music videos and commercials, for instance, to add some radical style to a piece. Here, too, DaVinci Resolve provides an abundance of features for manipulating unexpected aspects of the image; for example, by abusing the Custom Curves to create the illusion of chemical cross-processing.

![Custom Curves controls](image)

![Original image](image) ![Image enhanced with Curves](image)

DaVinci Resolve’s node-based image processing makes it possible to use more exotic node structures to create effects using composite modes, such as a colored glow generated by adding two differently graded versions of the same image together using a Layer node.

![Node tree adding two different treatments together](image)
You can also create complex node trees to build specific mattes, to use for isolating specific elements of the image. For example, if you wanted to isolate an actor in color against a background turned monochromatic, you can create multiple keys (pulled via HSL Qualification) and combine them using a Key Mixer node to build that effect.

Finally, DaVinci Resolve doesn’t just have tools governing color and contrast. A Blur palette provides controls over blurring, sharpening, or adding mist to all or part of the image. When combined with the other tools that are available for isolation and color adjustment, these are powerful additions to your creative arsenal.
Defocus effect created in real time

For more information on all of these features, see Chapters 124 through 140 of this manual.

**Quality Control**

Lastly, it’s important to keep in mind that, for all the creative possibilities that DaVinci Resolve affords, it’s still important that the final deliverables that you give to your client has appropriate signal levels relative to their requirements. In particular, programs destined for broadcast have specific outer boundaries of luma and chroma that you must not exceed, or you’ll risk having a show rejected for QC (quality control) violations.

However, even if you’re not delivering a show for broadcast, it’s important to be aware of the mathematical limitations of a digital video signal to make sure you’re not clipping or crushing image detail through overzealous adjustments that you may, in fact, want to preserve.

For example, if you take a look at the next two images, you can see the perils of overzealous adjustments when compared to a clip that, while graded creatively, has been adjusted with respect to the mathematical boundaries of image data.
Here, too, DaVinci Resolve provides tools designed to help you exercise control over the fine-tuning of the image. A Video Scopes window provides the standard Waveform, Parade, Vectorscope, and Histograms that are used to analyze your image data. These scopes let you see the boundaries of what’s possible, and make it easy to spot subtle problems, and compare the characteristics of one image to another.

When the time comes that you want to start clipping data in the highlights and shadows, as part of a creative look, the Soft Clip controls let you introduce a subtle or large roll-off, compressing the extremes of the signal so that what clipping you do is softer and more pleasing.

For more information about the video scopes and the Soft Clip controls, see Chapter 124, “Using the Color Page,” and Chapter 132, “Curves.”

**Never Stop Experimenting**

So now that you’ve gotten an extremely brief overview of the grading process as seen through the toolset of DaVinci Resolve, we invite you to use this manual to explore DaVinci Resolve more thoroughly. You may discover that, the more you work with the different features that are available, the more unexpected uses you’ll find for different controls that you thought you knew well.

Have fun.
Chapter 124

Using the Color Page

Given the origin of DaVinci Resolve as a professional grading application, the Color page is at the heart of the DaVinci Resolve experience. Within the Color page are all of the controls available for manipulating color and contrast, reducing noise, creating limited secondary color corrections, building image effects of different kinds, adjusting clip geometry, and making many other corrective and stylistic adjustments.

In this chapter, you’ll learn how to understand the Color page interface, how to customize it, and how to work within it to play through and navigate your project’s timeline. You’ll also learn how to analyze and compare clips in preparation for grading using stills, playheads, and DaVinci Resolve’s own internal video scopes.

Contents

The Color Page Interface 2498
  The Interface Toolbar 2498
  Showing Which Panel Has Focus 2499
  Viewer 2499
  Gallery 2501
  LUT Browser 2502
  Media Pool 2503
  Node Editor 2503
  Timeline 2504
  Palette Area 2505
  Dual Monitor Layout 2507
  The Info Palette and Clip Information 2508
  Clip Info 2508
  System Info 2509
  Clip Details 2509
  Customizing the Color Page 2510
  Undo and Redo in DaVinci Resolve 2511
The Color Page Interface

The Color page is divided into seven main areas that work together to let you build a grade. This section provides an overview of what these areas are and how they function.

The default layout of the Color page

The Interface Toolbar

At the very top of the Color page is a toolbar with buttons that let you show and hide different parts of the user interface. These buttons are as follows, from left to right:

The Interface toolbar

- **Gallery**: Opens and closes the Gallery panel.
- **LUTs**: Opens and closes the LUT Browser.
- **Media Pool**: Opens and closes the Media Pool.
- **Timeline**: Opens and closes the Mini-Timeline.
- **Clips**: Opens and closes the Thumbnail timeline. To the right is a drop-down menu that lets you choose a timeline filtering option for the Thumbnail timeline.
- **Nodes**: Opens and closes the Node Editor.
- **Open FX**: Opens and closes the Open FX panel.
- **Lightbox**: Opens and closes the Lightbox.
Showing Which Panel Has Focus

Whenever you click somewhere on the DaVinci Resolve interface using the pointer, or use a keyboard shortcut to “select” a particular panel (such as in the Edit page), you give that panel of the user interface “focus.” A panel with focus will capture specific keyboard shortcuts to do something within that panel, as opposed to doing something elsewhere in the interface. A highlight appears at the top edge to show you which panel has focus so that you can keep track of which part of the current page is taking precedence, and you can switch focus as necessary to do what you need to do. You can turn the Focus Indicator on and off in Preferences > User > UI Settings > Show focus indicators in the user interface.

![The focus indicator shown at the top edge of the Media Pool, shown next to a Viewer that doesn’t have focus](image)

Viewer

The Viewer shows the frame at the current position of the playhead in the Timeline. At the top of the Viewer is a header that displays the Project and Timeline names, as well as a Viewer Timecode display that shows the source timecode of each clip by default. The Timeline name is also a drop-down display that lets you switch to any other timeline in the project. A scrubber bar underneath the image lets you drag the playhead across the entire duration of the clip, while transport controls underneath that let you control playback. A toolbar at the top provides controls governing Image Wipes, Split-Screen controls, and Highlight display. Additional controls let you loop playback, switch Unmix mode on and off, turn audio playback on and off, and choose which onscreen controls are currently displayed. More information about using the Viewer appears later in this chapter.

![The default Viewer with transport controls](image)
You can also put the Viewer into one of three alternate modes to be able to see a larger image as you work. All three of these modes are available from the Workspace > Viewer Mode submenu.

- **Enhanced Viewer**: (Option-F to toggle this on and off) hides everything to the left and right of the Viewer, giving you a large working area for tasks such as window positioning and rotoscoping, while keeping the palettes and their controls visible as you work.

- **Full Screen Viewer**: (Shift-F to toggle this on and off) is available to provide more working area for tasks such as window positioning and rotoscoping. Full Screen Viewer also lets you display the Open FX panel at full height, and you can turn the Node Editor on and off to access different effects controls while you work.
– **Cinema Viewer:** (P to toggle this on and off) expands the Viewer to fill your workstation’s entire monitor. This is useful if you want to play the current Timeline without any distractions. When you move the pointer over the image, transport controls and a jog bar appear to let you control playback. For DITs, a contextual menu is available by right-clicking anywhere on the image with which you can turn on and customize a video scope overlay (which can be dragged to different locations on the Viewer).

![The Color page in Cinema Viewer mode](image)

**Gallery**

The Gallery is used for storing still frames to use as reference, and grades you might like to copy; stills and grades are stored together. A button lets you open up the Album browser, used for organizing your stills. At the bottom of the Gallery, Memories let you store grade information that you can apply using a control panel or keyboard shortcuts. The Gallery on the Color page mirrors the contents of the Gallery page. For more information on the Gallery page, see Chapter 138, “Using the Gallery.”

![The Gallery has Memories, stills saved in albums and your PowerGrades](image)
LUT Browser

The LUT Browser provides a centralized area for browsing and previewing all of the LUTs installed on your workstation. All LUTs appear in the sidebar, by category.

By default, all LUTs appear with a test thumbnail that give a preview of that LUT’s effect, but you can also get a live preview of how the current clip looks with that LUT by hover scrubbing with the pointer over a particular LUT’s thumbnail (this is described in more detail below).

To open the LUT Browser:

– Click the LUT Browser button in the UI Toolbar at the top of the Color page.

Methods of working with the LUT Browser:

– **To see the LUTs in any category:** Click on a LUT category to select it in the sidebar, and its LUTs will appear in the browser area.

– **To make a LUT a favorite:** Hover the mouse over a LUT and click the star badge that appears at the upper right-hand corner, or right-click any LUT and choose Add to Favorites. That LUT will then appear when you select the Favorites category.

– **To search or filter for specific LUTs:** Open a bin that has the LUT you’re looking for, then click the magnifying glass icon to open the search field, and type text that will identify the LUTs you’re looking for.

– **To see LUTs in Column or Thumbnail view:** Click the Column or Thumbnail buttons at the top right of the LUT Browser to choose how to view LUTs in the browser area.

– **To sort LUTs in Thumbnail view:** Click the Thumbnail Sort drop-down menu and choose which criteria you want to sort LUTs by. The options are Filename, Type, Relative Path, File Path, Usage, Date Modified. There are also options for ascending and descending sort modes.

– **To sort LUTs in Column view:** Click the column header to sort by that column. Click a header repeatedly to toggle between ascending and descending modes.

– **To update the thumbnail of a LUT with an image from a clip:** Choose a clip and frame that you want to use as the new thumbnail for a particular LUT, then right-click that LUT and choose Update Thumbnail With Timeline Frame.

– **To reset the thumbnail of a LUT to use the standard thumbnail:** Right-click a LUT and choose Reset Thumbnail to go back to using the standard test image.

– **To refresh a LUT category with new LUTs that may have been installed:** Select a LUT category, then right-click anywhere within the browser area and choose Refresh to refresh the contents of that category from disk.
Methods of adding LUTs to a grade from the LUT Browser:

– **To apply a LUT to the current node:** Select a clip in the Thumbnail timeline, then right-click a LUT and choose Apply LUT to Current Node from the contextual menu.

– **To apply a LUT to a specific node:** Drag a LUT from the LUT Browser and drop it onto the node you want to apply a LUT to. If you drag a LUT onto a node that already has a LUT, the previous LUT will be overwritten by the new one.

Media Pool

The Media Pool is available in the Color page, making it easy to drag and drop clips you want to use as external mattes right into the Node Editor, for easy and fast connection to create various Color page effects. When opened, the Media Pool replaces the Gallery, fitting into the same area. In most respects, the Media Pool in the Color page works the same as the Media Pool on nearly every other page of DaVinci Resolve.

When you drag a clip from the Color page Media Pool to the Node Editor, two things happen:

– That clip is turned into an external matte in the current grade, which you can use as a matte for secondary adjustments, or as a compositing layer (in conjunction with the Layer mixer) for mixing textures or images with your grade.

– That clip is also automatically attached to the Media Pool clip that corresponds to the clip you’re grading as a clip matte, to help you keep track of which clips are using other clips as mattes.

For more information about the Media Pool, see Chapter 17, “Adding and Organizing Media with the Media Pool.”

Node Editor

The Node Editor is where you assemble one or more individual corrections (nodes) together into a complete multi-correction grade (node tree). This is a powerful way of assembling grades, since different types of nodes let you create different combinations of corrections and very specific adjustments by reordering operations, combining keys, or changing the layer order of different adjustments. For more information about the Node Editor, see the “Node Editor Basics” section of Chapter 140, “Node Editing Basics.”
Timeline

The Timeline provides several ways of navigating the clips in your project, as well as keeping track of what has been done to which clips. The Timeline is divided into two parts, each of which shows different information and provides differing controls, and each of which can be opened or closed separately via the Clips and Timeline buttons on the Interface toolbar.

Thumbnail Timeline

At the top is the Thumbnail timeline, in which each clip is represented by a single frame. The Thumbnail timeline (or its alter-ego, the Lightbox) provides the easiest way of selecting which clip you want to work on and of making clip selections for various grade management operations. The currently selected clip that reveals its controls in the various palettes of the Color page is highlighted in orange.

Much valuable information appears above and below each thumbnail, such as each clip’s clip number, source timecode, track number, whether it’s been flagged, whether it’s automatically linked or part of a group, whether it’s been tracked, and so on.
What’s displayed underneath each thumbnail can be changed by double-clicking the space underneath each thumbnail. There are several options; you can keep double-clicking to cycle among them:

– Clip format or codec (the default)
– Clip Name (clip name or file name, depending on what View > Show File Name is set to) or Multicam Angle (if you’re working with multicam clips)
– Version name or number

**Mini-Timeline**

Underneath, the Mini-Timeline shows a small representation of the video tracks of the Timeline in the Edit page wherein each clip is as long as its actual duration. This provides the best representation of the structure of the current timeline, in which clip length shows duration and multiple tracks are displayed, so you can see which clips are superimposed. A Timeline Ruler lets you scrub the playhead across multiple clips and can be zoomed out enough to show every clip in your entire program.

![Mini-Timeline](image)

The Mini-Timeline lets you see timeline structure, and small track header controls let you enable tracks, disable tracks, and set the playhead to ignore specific tracks.

Small track labels at the left of each track in the Mini-Timeline let you enable or disable tracks by clicking them (enabled tracks have white labels, disabled tracks have gray labels). Option-clicking one of these controls sets that track to be enabled but ignored by the playhead when you use the Next and Previous Clip commands, in the event you want to ignore clips you don’t need to grade (tracks in this mode show a red label).

Within the Mini-Timeline the currently selected clip is highlighted in orange, and you can click any clip to select it. A scroll bar at the bottom lets you navigate to the left and right, while using the scroll wheel of your mouse zooms in and out. The Mini-Timeline shows at most six tracks of video. If your project has more tracks than that, you can scroll up and down to reveal the hidden tracks. Any markers that were placed on clips or the Timeline in the Edit page appear here, and you can click any marker to reveal and edit its color and notes.

As seen above, a colored outline appears around the clip number of shots that have been graded, and this outline is doubled if there are additional versions applied to that clip.

For more detailed information about the Color page Timeline, see Chapter 126, “Color Page Timeline and Lightbox.”

**Palette Area**

Most everyday tools and functions for grading are distributed among a series of palettes found in the palette area of the Color page. These palettes can be accessed via a series of palette buttons running along the Palette bar at the top of this area.

![All palettes seen in the Palette bar](image)

These buttons also give you feedback about which palettes have adjustments for the current selected node in the Node Editor. Palettes with adjustments show a small orange dot in the corresponding palette button.
An orange dot in a palette button lets you know there are adjustments in that palette.

Left Palettes

A series of palettes at the bottom left of the Color page provide access to different sets of grading tools, used principally for manipulating color, contrast, and raw media format settings. Each individual palette is opened by clicking the corresponding icon at the top of the Palette panel.

Left palette selection buttons

The five available palettes are the Camera Raw palette (for making metadata adjustments to raw media formats), the Color Match palette (automatic grading based using test charts), the Primaries (graphical color balance controls and master wheels, along with a Slider mode for adjusting YRGB Lift/Gamma/Gain), the HDR palette (advanced primary grading controls designed for wide-gamut media and SDR or HDR mastering), the RGB Mixer (for mixing color channels into one another), and the Motion Effects palette (with controls for noise reduction and artificial motion blur). These palettes can be used individually or together depending on what you're trying to accomplish. For more information on most of these palettes, see Chapter 129, “Primaries Palette.” For more information on the Motion Effects palette, see Chapter 151, “The Motion Effects and Blur Palettes.”

Center Palettes

At 1920x1080 resolution or higher, a second set of palettes is organized at the bottom center of the Color page. These palettes span a wide range of functionality, and the adjustments you make with them can be combined with those made using the Color palettes.

Center palette selection buttons

**NOTE:** At lower resolutions, the Left and Center palettes are merged to fit the DaVinci Resolve interface into a smaller area.

The eight available Center palettes include the Curves palette, the Color Warper palette, the Qualifier palette, the Window palette, the Tracker palette, the Magic Matte palette, the Blur palette, the Key palette, the Sizing palette, and the Stereoscopic 3D palette.

Keyframe Editor, Video Scopes, and Information

The bottom right of the Color page can be switched between one of three things:

*The three controls for displaying the Keyframe Editor, video scopes, or Information palette*
– **Keyframe Editor**: Provides an interface for animating Color, Sizing, and Stereo Format adjustments over time. Each node in the Node Editor corresponds to a track in the Keyframe Editor, which lets you animate each node’s adjustments independently. Furthermore, each node’s track can be opened up to reveal parameter groups, so that you can animate subsets of an individual node’s functions independently of other functions within the same node. For more information about keyframing, see Chapter 145, “Keyframing in the Color Page.”

– **Video scopes**: Provides a docked area where you can expose one video scope at a time for reference while you work. You can also “undock” the video scopes into a stand-alone window, in which you can show four different scopes at a time. More information about using the video scopes appears later in this chapter.

– **Information**: Provides a way of seeing clip and system information while you work.

### Dual Monitor Layout

The Color page has a dual monitor layout that provides maximum space for the Viewer, Node Editor, and Control palettes on the primary monitor, and a simultaneously displayed Gallery, Lightbox, Keyframe Editor, Metadata Editor, and Video Scope panel on the secondary monitor.

**To enter dual screen mode:**

– Choose Workspace > Dual Screen > On.
To switch which UI elements appear on which monitors:
– Choose Workspace > Primary Display > (Monitor Name), which reverses the contents of both monitors in dual screen mode.

The Info Palette and Clip Information

The Info palette is hidden by default. Clicking the Info palette button at the far right of the toolbar reveals it at the right of the Center palette. The Info palette has two tabs that display different information. There are no user-editable controls in the Info palette.

Clip Info

The first tab displays information about whichever clip is currently selected in the Timeline. This information is not editable, but is provided for reference, and includes:

– **File Name:** The name of the media file on disk. If the current clip is a Multicam clip, this shows the name of the currently selected angle.
– **Reel Name:** The reel name of that clip, if one is being read properly.
– **Start T/C:** The source timecode value of the first frame in the clip.
– **End T/C:** The source timecode value of the last frame in the clip.
– **Duration:** The duration of the clip, in timecode.
– **Frames:** The duration of the clip, in frames.
– **Version:** The name of the remote or local version used by that clip.
– **Frame Rate:** The frame rate used by that clip.
– **Source Res:** The native resolution of the source clip.
– **Codec:** The codec or format used by the source clip.
System Info

The second tab displays information about operational modes currently in use by DaVinci Resolve. It's meant to provide the status of different DaVinci Resolve features that can be enabled, disabled, or cycled among various options. This information includes:

- **Clips**: The total number of clips in the Timeline.
- **Proxy**: The status of Proxy mode (On or Off).
- **Clip Cache**: The status of the Clip Cache mode (Off, All, Dissolves, User, User & D).
- **Ref Transform**: The status of Reference Still reposition.
- **Ref Mode**: The status of the Reference mode (Gallery, Timeline, Offline).
- **Wipe Style**: The currently selected Wipe Style for split screens (Wipe-H, Wipe-V, Wipe-M, Wipe-A).
- **Convergence**: The current Convergence setting (Linked Zoom, Opposite)
- **Stereo Grade**: The currently displayed Eye and Gang mode (Left or Right - Gang or Solo).
- **Stereo Display**: The current Stereo Display mode (Mono or Stereo).

Clip Details

You can right-click the currently selected clip in the Thumbnail Timeline and choose View Clip Details to show a small window with all of that clip's information available at a glance. You can drag this window anywhere you like, even to another display.

![Clip Details window](image)

This information is not editable, but is provided for easy reference, and includes:

- **File Name**: The name of the media file on disk appears at top.
- **Start Timecode**: The source timecode value of the first frame in the clip.
- **End Timecode**: The source timecode value of the last frame in the clip.
- **Duration**: The duration of the clip, in timecode.
- **Frames**: The duration of the clip, in frames.
- **Reel Name**: The reel name of that clip, if one is being read properly.
- **Version**: The name of the remote or local version used by that clip.
- **Format**: The format used by the source clip, along with the frame size and bit depth.
– **Codec:** The codec used by the source clip.
– **Folder:** Which directory on disk the source media resides in.
– **Description:** The description field of the Metadata Editor.
– **Comments:** The Comments field of the Metadata Editor.
– **EDL Comments:** EDL comments for that event, if any exist.

### Customizing the Color Page

The various sections of the Color page can be resized, hidden, and rearranged as needed to accommodate different working styles. This section covers all of the methods that are available for Color page customization.

You can easily resize the Viewer, Gallery, and Nodes Editor relative to one another to make the Viewer larger, expand the width of the Node Editor to have more workspace, or to create more or less room for stills in the Gallery.

**To resize the Viewer, Gallery, and Node Editor:**
- Move the pointer over the vertical divider between any two areas. When the resize icon appears, drag the divider to the left or right to make one area larger while making the other smaller.

You can also fully expand the Gallery, the Memories, the Node Editor, and the Keyframe Editor to replace completely whichever interface area is adjacent.

**To expand the Keyframe Editor, Viewer, and Gallery:**
- Click the Expand control at the upper right of whichever interface area you want to expand. Once expanded, clicking the Expand control again will collapse that interface area back to its original size, revealing whatever was hidden.

In Display mode, you can completely hide the Viewer, pushing the Gallery all the way to the right side of the DaVinci Resolve window, and expanding the Node Editor to take the rest of the space.

**To toggle Display mode, do one of the following:**
- Right-click in the empty area of the Node Editor, and choose Toggle Display Mode from the contextual menu. Do this again to toggle Display Mode off and return the interface to the way it was.
- Press SHIFT UP and DISPLAY/CURSOR, above the fourth trackball of the Center panel of the DaVinci control panel.

**To show and hide the Mini-Timeline:**
- Click the Timeline button at the right of the palette button bar.

**To show and hide the Color page Viewer upper toolbar:**
- Click the Viewer option menu and choose Show Viewer Options to uncheck it.

**To return all pages to their default layout:**
- Choose Workspace > Reset UI Layout.
Undo and Redo in DaVinci Resolve

No matter where you are in DaVinci Resolve, Undo and Redo commands let you back out of steps you’ve taken or commands you’ve executed, and reapply them if you change your mind. DaVinci Resolve is capable of undoing the entire history of things you’ve done since creating or opening a particular project. When you close a project, its entire undo history is purged. The next time you begin work on a project, its undo history starts anew.

Because DaVinci Resolve integrates so much functionality in one application, there are three separate sets of undo “stacks” to help you manage your work.

– The Media, Cut, Edit, and Fairlight pages share the same multiple-undo stack, which lets you backtrack out of changes made in the Media Pool, the Timeline, the Metadata Editor, and the Viewers.
– Each clip in the Fusion page has its own undo stack so that you can undo changes you make to the composition of each clip, independently.
– Each clip in the Color page has its own undo stack so that you can undo changes you make to grades in each clip, independently.

In all cases, there is no practical limit to the number of steps that are undoable (although there may be a limit to what you can remember). To take advantage of this, there are three ways you can undo work to go to a previous state of your project, no matter what page you’re in.

To simply undo or redo changes you’ve made one at a time:

– Choose Edit > Undo (Command-Z) to undo the previous change.
– Choose Edit > Redo (Shift-Command-Z) to redo to the next change.
– On the DaVinci control panel, press the UNDO and REDO buttons on the T-bar panel.

TIP: If you have the DaVinci control panel, there is one other control that lets you control the undo stack more directly when using the trackballs, rings, and pots. Pressing RESTORE POINT manually adds a memory of the current state of the grade to the undo stack. Since discrete undo states are difficult to predict when you’re making ongoing adjustments with the trackball and ring controls, pressing RESTORE POINT lets you set predictable states of the grade that you can fall back on.

You can also undo several steps at a time using the History submenu and window. At the time of this writing, this only works for multiple undo steps in the Media, Cut, Edit, and Fairlight pages.

To undo and redo using the History submenu:

1. Open the Edit > History submenu, which shows (up to) the last twenty things you’ve done.
2. Choose an item on the list to undo back to that point. The most recent thing you’ve done appears at the top of this list, and the change you’ve just made appears with a check next to it. Steps that have been undone but that can still be redone remain in this menu, so you can see what’s possible. However, if you’ve undone several changes at once and then you make a new change, you cannot undo any more and those steps disappear from the menu.
Once you’ve selected a step to undo to, the menu closes and the project updates to show you its current state.

**To undo and redo using the Undo window:**

1. Choose Edit > History > Open History Window.

2. When the History dialog appears, click an item on the list to undo back to that point. Unlike the menu, in this window the most recent thing you’ve done appears at the bottom of this list. Selecting a change here grays out changes that can still be redone, as the project updates to show you its current state.

3. When you’re done, close the History window.
Chapter 125

Viewers, Monitoring, and Video Scopes

Viewers let you see what you’re working on, provide a UI for transport controls and image comparison, draw windows and drag on-screen controls, and provide a variety of warnings and information not found anywhere else. However, at the same time, professional workflows require real time monitoring via supported video I/O devices on a calibrated display. Lastly, video scopes provide a more precise analysis of the state of the video signal you’re viewing, and DaVinci Resolve has built-in scopes you can use for creative decision making and troubleshooting.

This chapter covers the Color page Viewer, external monitoring and display calibration, and video scopes in more detail.

Contents

Using the Viewer ............................................................ 2515
The Viewer Title Bar ..................................................... 2515
Turning Grades and/or Fusion Effects Off ......................... 2516
Viewing Isolated Channels ........................................... 2516
The Viewer Toolbar ....................................................... 2516
The Onscreen Control (OSC) Menu .............................. 2517
Toggling Viewer Overlays On and Off ........................... 2518
Onscreen Controls and External Displays ...................... 2518
Zooming into the Viewer ............................................... 2519
Using the Jog Bar and Transport Controls ...................... 2519
Navigating Using the Arrow Keys ................................ 2520
Controlling Playback Using the Spacebar and JKL Keys .... 2520
Fast Review on the Color Page ..................................... 2520
Navigating Using Timecode .......................................... 2520
Viewer and Transport Timecode Displays
Enhanced, Full, and Cinema Viewing
Enhanced Viewing Mode
Full Viewing Mode
Cinema Viewing Mode
Safe Area Overlays in the Viewer
Use Gray Background
Monitor Calibration
Viewing Broadcast Safe Exceptions
Comparing Clips in the Viewer
Saving and Wiping Stills in the Gallery and Timeline
Different Viewer Reference Modes for Wipes
Wiping Between Clips in the Timeline
Using Split Screen Modes
Marker Overlays and Navigation
Timeline Marker List Available in Color Page Viewer Option Menu
Using Video Scopes
Video Scope Location
Video Scope Measurement Using Scales
Video Scope Performance and Detail
Display Qualifier Focus in Video Scope Graphs
Explanation of Each Video Scope
Waveform Monitor
Parade
Vectorscope
Histogram (RGB/YRGB parade histogram)
CIE Chromaticity Scope
Panning and Zooming the Video Scopes
Customizing the Video Scopes
Parade Scope Display Options
Waveform Scope Display Options
Vectorscope Display Options
Histogram Display Options
CIE Chromaticity Display Options
Using the Viewer

The Viewer is your window into the Timeline. The clip and frame at the current position of the playhead appears in the Viewer. The Viewer also provides a workspace for picking colors, adjusting Windows, using split screen stills for reference, and many other display-oriented tasks. If you have a video out interface connected to a broadcast display or projector, then the contents of the Viewer are typically mirrored by the video output.

The Viewer Title Bar

The Viewer title bar has controls and indicators making it easy to control and keep track of what it is you’re looking at.

The Viewer title bar has the following controls:

- **Zoom and Fit menu**: Lets you zoom to a specific percentage, or choose Fit to fit the image to the total available area of the Viewer.

- **Playback frame rate indicator**: A dot shows green if playback performance matches the frame rate of the project, or red if playback performance drops below real time. To the right, the current frame rate is displayed.

- **Timeline name and selection drop-down**: The name of the currently open timeline is displayed. A drop-down to the right lets you open any other timeline in the current project to take its place.

- **Timecode viewer and drop-down**: A second timecode viewer lets you choose an alternate timecode/frame count/KeyKode value to display simultaneously to the timecode viewer next to the transport controls below. A drop-down lets you pick whether to display source (clip) or record (timeline) timecode.

- **Bypass Color and Fusion and drop-down**: Lets you disable grades and/or Fusion effects.

- **Expand Viewer drop-down**: Expands the Viewer to take up the full area of your workstation’s display above the palettes.

- **Option menu**: Has options that affect the Viewer’s functionality. Commands include: Gang Timeline wipe with current clip, Gang Viewer zoom with video output, Show clip flags on video output, Show Viewer options, Show Marker overlays, and the Marker list for navigating among all Timeline markers in the currently open timeline.
Turning Grades and/or Fusion Effects Off

The Bypass Color Grades and Fusion Effects button/drop-down commands in the Viewer’s title bar are also available via View > Bypass Color and Fusion menu commands. Turning off Fusion effects in the Color page is an easy way to improve playback performance on low power systems when you just need to make a quick set of grading adjustments. Toggling grades off and on is also a convenient way to quickly get a before-and-after look at a shot where the “before” goes all the way back to the source.

If you choose Toggle Bypass or click the Viewer control, you’ll turn off whatever is checked in the optional menu, which lets you choose whether or not you want to bypass both Color and Fusion, or just one or the other.

(Tip) Menu commands for bypassing Color and Fusion, (Right) Edit page Timeline Viewer controls

TIP: If you’re giving your client a before and after look at work you’re doing on a grade, a more effective technique is to select the specific nodes (one or more) that you want to toggle on and off, and press Command-D (Enable/Disable Selected Nodes.)

Viewing Isolated Channels

Use the View > Viewer Channels submenu to switch the Color page Viewer among RGB, R, G, or B channels. This can be useful when evaluating a single channel of an image for noise or other artifacts, or for doing color matching by comparing and adjusting the individual red, green, and blue channels of two different clips.

The Viewer Toolbar

The Color page also exposes a toolbar at the top of the image (underneath the title bar) that makes it easy to enable and disable image wipe, split screen, and highlight viewing by clicking one of these three buttons, which then expose additional controls relating to each of these modes of operation (described elsewhere in this chapter). This toolbar can be shown or hidden by clicking the Viewer option menu and unchecking Show Viewer Options.

The Color page Viewer toolbar showing the Wipe, Split Screen, and Highlight controls

In the process, these buttons provide an easy reference for when a comparison mode is enabled. In each of these Viewer modes, the appropriate controls for customizing that view appear to the right of the Viewer toolbar.
The Onscreen Control (OSC) Menu

The Onscreen Control drop-down menu lets you choose which onscreen controls you want to display and adjust in the Viewer. Some palettes automatically enable corresponding onscreen controls when you open them. For example, opening the Window palette displays the Power Window onscreen controls, and opening the Qualifier palette displays the Qualifier onscreen controls.

There are a variety of choices, each corresponding to different adjustments you can make:

- **Off**: All onscreen controls are hidden from view, giving you an unimpeded display of the image in the Viewer.
- **Qualifier**: Turns on the Color Sample cursor, which lets you choose a color using the fourth trackball of the DaVinci control panel. For more about using Color Sample controls, see Chapter 134, “Secondary Qualifiers.”
- **Power Window**: Turns the Power Windows onscreen control on and off. For more about adjusting windows in the Viewer, see “Power Windows” in Chapter 135, “Secondary Windows and Tracking.”
- **Image Wipe**: Toggles mouse control of dragging the split screen directly on the Viewer on and off. For more about working with split screens, see “Comparing Clips in the Viewer” later in this chapter.
- **Dust Removal**: Activates the interactive Dirt and Dust tool. For more information, see Chapter 152, “Dust Removal.”
- **Open FX**: Shows and hides whatever onscreen controls are exposed by an Open FX plug-in in the currently selected node.
- **Color Chart**: Shows and hides the color chart overlay that lets you identify a color chart in the picture that you want to use with the Color Match palette to create an automatic grade.

**TIP**: As you work, you may find you want to temporarily hide or show the onscreen controls so you can get an uncluttered look at the image you’re adjusting. You can toggle any set of onscreen controls off and on without selecting Off in the menu by pressing Shift-` (tilde).
Toggling Viewer Overlays On and Off

Pressing Shift-` (Tilde) turns the current Viewer overlay on and off. The View > Viewer Overlay submenu contains commands for showing, hiding, and switching different overlays in the Color page Viewer. While most of the options in this menu are unassigned by default, they can be assigned to keys using the Keyboard Customization window.

Onscreen Controls and External Displays

DaVinci Resolve has been designed for use with calibrated external displays connected to video output interfaces, and for most colorists working on broadcast or theatrical programs, this is the recommended way to work for color critical evaluation.

Because of this, many of the onscreen controls associated with tasks such as color sampling, window adjustment, and key manipulation are mirrored to your video output, making it possible to hide the Viewer on your computer’s monitor and work with only an external display.

To choose whether onscreen controls are mirrored to video out or disabled:

- Choose an option from the View > Window Outline submenu.

There are three options:

- **Off**: Hides the window outline on both the external display and the Viewer.
- **On**: The default, shows the window outline on both the external display and the Viewer.
- **Only UI**: Hides the window outline on your external display, but leaves it in the Viewer.

To show clip flags on video output:

- Turn on the “Show clip flags on video output” checkbox option in the Color page Viewer’s Option menu. This enables drawing one or more small colored flag overlays in the bottom-left corner of video output. This way, you can always see which clips are flagged on your grading hero display as you work, if that helps you to keep track of whatever you’re using flags to stay on top of. This is off by default.

Limitations When Grading With the Viewer on a Computer Display

Most computer displays do not operate at the color critical tolerances or specifications required for quality control for streaming, broadcast, or theatrical delivery. An additional issue, however, is that depending on your combination of workstation and computer display, the Viewer does not necessarily display each clip’s image data as it is displayed by the calibration that your operating system applies to your computer display, depending on which OS you’re running DaVinci Resolve on. This makes your computer display potentially unsuitable for monitoring projects destined for the sRGB standard of the web in its default state. For example, if you grade a project using the Color page Viewer on your computer display, the resulting clip may not look the same in the QuickTime player, or in other post-production applications.

You can address this in one of two ways:

- If you’re using DaVinci Resolve on macOS, you can turn on “Use Mac Display Color Profile for viewers” in the Hardware Configuration panel of the System Settings. This lets DaVinci Resolve use whichever of the color profiles you choose in the Color tab of the Displays panel in the macOS System Preferences, thereby taking advantage of ColorSync on macOS to let DaVinci Resolve display color the way your computer monitor does. This now works for all color profiles that ship with macOS, as well as color profiles that have been generated by calibration software, such as that available from X-rite, Datacolor, or other applications. On supported computers, there’s also an option to “Use 10-bit precision in viewers,” if available, that you can turn on. With this option enabled, rendered output displayed in QuickTime Player will match what is seen in the DaVinci Resolve Viewer.
– Alternately, you can apply a dedicated Color Viewer LUT for calibration, using the 1D/3D Color Viewer Lookup Table drop-down menu that’s found in the Color Management panel of the Project Settings. This lets you analyze your computer display for calibration in the same way you would calibrate an external display, using a probe and color management software, and apply the resulting calibration LUT in DaVinci Resolve. Keep in mind that monitor calibration can only make a high quality display standards compliant; it cannot make up for a display gamut that’s too small. For more information, see the “Lookup Tables” section of Chapter 4, “System and User Preferences.”

Strictly speaking, if you’re doing professional work, you should restrict your grading using a calibrated, 10- or 12-bit class A external broadcast display of some type, connected via a Blackmagic Design video interface. Assuming everything is running properly, an image that is output to video from DaVinci Resolve should match an image output to video from any other post-production application you’re using, and this should be your basis for comparison when examining the output of two different applications.

### Zooming into the Viewer

When using the Viewer to sample tricky colors or draw a detailed PowerCurve, it can be advantageous to zoom into the image.

**To zoom into or out of the Viewer, do one of the following:**

– Move the pointer to within the Viewer, and then roll the scroll wheel to zoom in or out of the image.
– Press Command-Equal to zoom in, or Command-Minus to zoom out.

**To pan around the Viewer:**

– Move the pointer to within the Viewer, then middle-click and drag to pan around the image.

**To reset the size of the Viewer image:**

– Choose View > Viewer Actual Size (Option-Shift-Z).
– Choose View > Zoom > Zoom to Fit (Shift-Z).

**To enable or disable image zoom being sent to video out:**

– Choose “Gang viewer zoom with video output” from the Option menu of the Viewer to zoom the image shown on video out identically to the zoom level of the Viewer, enabling you to evaluate a zoomed-in portion of the image on your suite’s hero display.

### Using the Jog Bar and Transport Controls

One of the principal uses of the Viewer is to control playback. The jog bar, directly underneath the image in the Viewer, contains a playhead that you can drag to the left and right to navigate quickly through the currently selected clip as fast as you can move the pointer. The playhead in the jog bar is locked to the playheads found in the Timeline and Keyframe Editor. Moving one playhead moves all three.

How much of the Timeline the jog bar navigates depends on whether the Node Editor is set to Clip or Timeline mode. In Clip mode, the jog bar width equals the duration of the currently selected clip. In Timeline mode, the jog bar width equals the total duration of the entire Timeline.
A row of transport controls below the jog bar provides more specific control over timeline playback.

- **Previous clip**: Moves the playhead to the first frame of the previous clip.
- **Reverse**: Initiates 100% playback in reverse.
- **Stop**: Stops playback.
- **Play**: Initiates 100% playback.
- **Next clip**: Moves the playhead to the first frame of the next clip.
- **Loop**: Lets you restrict playback to the current clip, looping to the first frame if you’re playing forward to the end of a clip, or looping to the last frame if you’re playing in reverse to the beginning of a clip.

Two other buttons let you control audio playback and clip display in the Viewer:

- **Unmix**: Turning on Unmix disables all transitions, composited superimpositions, and effects that mix two or more clips together. Unmix allows you to judge the appearance of a clip without distraction whenever you need to make an adjustment based on how the clip looks on its own, or whenever you need to make changes based on frames that would otherwise be hidden underneath a transition such as a dissolve or fade from black. When you’re ready to see how your grades work in context with transitions and composites again, turn Unmix off.
- **Mute**: Lets you turn audio playback off and on for your current timeline.

**Navigating Using the Arrow Keys**

You can use the Arrow Keys of the keyboard to navigate clips and the Timeline in different ways.

- **Up/Down Arrow**: Moves the playhead to the first frame of the previous or next clip.
- **Left/Right Arrow**: Moves the playhead back or forward one frame at a time.
- **Shift-Left/Right Arrow**: Moves the playhead back or forward one second at a time.

**Controlling Playback Using the Spacebar and JKL Keys**

You can also use the spacebar to start and stop playback, or the JKL keyboard shortcut convention for controlling playback, where J plays in reverse, K stops playback, and L plays forward. There are many additional uses of these keyboard shortcuts; for more information see “Using JKL to Control Playback” in Chapter 36, “Preparing Clips for Editing and Viewer Playback.”

**Fast Review on the Color Page**

The Fast Review playback command (Playback > Fast Review) is now available on the Color page. Intended to help you watch through long sequences of clips quickly, clicking this button begins accelerated playback through the Timeline, where the speed of playback is relative to the length of each clip you’re playing through. Long clips play faster, whereas shorter clips play closer to real time.

**Navigating Using Timecode**

You can also use absolute or relative timecode entry to move the playhead in the Color page Viewer. When entering timecode, type each pair of hour, minute, second, and frame values consecutively, with a period representing a pair of zeros for fast entry. The last pair of timecode values (or period) you enter is always assumed to be the frame number, with any untyped values assumed to be zero. It's not necessary to enter colons or semicolons. For more information, see “Moving the Playhead Using Timecode” in Chapter 36, “Preparing Clips for Editing and Viewer Playback.”
Viewer and Transport Timecode Displays

The Viewer has two timecode displays, each of which defaults to a different timecode setting. A
timecode display at the top, the Header timecode display, shows the Source timecode by default. The
timecode display at the bottom, the Transport timecode display, shows the Record timecode by
default. The bottom timecode display can be changed to show one of four different options, which are
similar to those found in the Data Burn-In palette.

To change a timecode display to a different setting:
The top timecode display is a drop-down menu that can be changed to whatever timecode, frame
number, or KeyKode you want to display. The bottom timecode display can also be changed by
right-clicking on it and choosing the type of value to show from the contextual menu that appears.
There are the following options:

- **Timeline Timecode**: The timecode corresponding to the playhead’s position in
  the overall Timeline.
- **Source Timecode**: The timecode corresponding to the playhead’s position relative to the currently
  selected clip.
- **Timeline Frame**: The frame count corresponding to the playhead’s position in the overall Timeline.
- **Source Frame**: The frame count corresponding to the playhead’s position relative to the currently
  selected clip.
- **KeyKode**: The KeyKode number corresponding to the media’s KeyKode track, if there is one.
- **Show Timecode at 30 FPS**: Displays 24 fps timecode, via 3:2 pulldown, as 29.97 fps timecode.
  Has no effect on video playback.
- **Copy and Paste Timecode**: Two commands make it easy to copy and paste timecode values.

In the same way, the top timecode display can alternately be changed to show KeyKode, if it’s
available, within a DPX media file’s header.

Enhanced, Full, and Cinema Viewing

You can expand the Viewer into Enhanced Viewing mode by choosing Workspace > Viewer Mode >
Enhanced Viewer mode (Option-F), or by pressing CURRENT/VIEWER on the T-bar panel of the
DaVinci control panel.

Enhanced Viewing Mode

In Enhanced Viewing mode, the Viewer works exactly as it does at its regular size, but it expands to fill
up the entire area of the screen above the palettes and Keyframe Editor. To exit Enhanced Viewing
mode, press (Option-F) again.

This can be useful if you need a closer view of the image for purposes of making detailed corrections,
examining noise patterns up close, making a tricky color selection, or drawing a complicated
PowerCurve.
Full Viewing Mode

In Full Viewing mode (available by choosing Workspace > Viewer Mode > Full Page Viewer, pressing Shift-F, or Option-clicking the Enhanced Viewing mode button), the Viewer takes up even more room by hiding the palette controls, but leaves room for the transport controls, the Onscreen Control drop-down menu, the timecode display, and the page buttons along the bottom of the DaVinci Resolve UI. This mode is useful when you need an even closer look at the image, but you still want access to a minimal set of onscreen controls.

Cinema Viewing Mode

Another option, Cinema mode, allows for full-screen viewing. Cinema mode is available by choosing Workspace > Viewer Mode > Cinema Mode Viewer (P). In Cinema mode, the menu bar is hidden, and
the image is presented full screen without any of the ordinary onscreen controls. Moving the pointer over the screen reveals a set of hidden onscreen controls that include a play button, jog bar, mute button, and exit button (which lets you turn off Cinema mode). You also have the option of superimposing scopes over the image, which can be valuable in on-set situations.

Color page in Cinema mode

Cinema mode is useful for doing detailed reviews of media in on-set and digital dailies workflows when working remotely without a secondary video display.

**TIP:** If you'd like to superimpose timecode over the image in Cinema mode for reference, you can use the controls within the Data Burn-In window (Workspace > Data Burn-In) to set up whatever information you'd like to display during playback.

**Safe Area Overlays in the Viewer**

You can show or hide a series of safe area overlays in the Viewer. All safe area overlay options are found in the View > Safe Area menu. Each safe area overlay option can be individually enabled or disabled from this menu.

Viewer displaying extents, center, safe, action and title area overlays
– **On/Off:** Turns all currently selected safe area marker options on or off at once.

– **Extents:** An outline showing the exact outer edge of the frame. Especially useful when the safe markers are set to an aspect ratio other than that currently used by the Viewer.

– **Action:** An outline showing the outer 90% action safe area of the frame.

– **Title:** An outline showing the outer 80% title safe area of the frame.

– **Center:** A crosshairs showing the center of the frame.

– **Aspect:** Enables use of the View > Select Aspect Ratio submenu to change the aspect ratio of the safe area markers. You can choose among the following aspect ratios: 1.33 (a.k.a. 4:3), 1.66, 1.77 (a.k.a. 16:9), 1.85, and 2.35.

You can also access these options directly using the DaVinci control panel.

### Use Gray Background

Choosing View > Show Gray Backgrounds in Viewer sets the empty area of the Viewer (if there is any) to a lighter gray, making it easier to see which parts of the Viewer are black because of blanking, and which parts are simply empty because of the way the image is zoomed or panned.

### Monitor Calibration

If you use Light Illusion's LightSpace CMS or SpectraCal's Calman for display calibration, you can now use DaVinci Resolve as a sync-able pattern generator. This means you can use DaVinci Resolve to output color patches, synchronized by LightSpace, to your display through whichever video interface is connected to your computer. These synchronized color patches will be analyzed by a monitor probe that's also controlled by LightSpace, which stores the probe data and compares it to the original color values of the output color values in order to characterize that display.

To use this feature, you must first have a licensed copy of LightSpace CMS, which is a Windows application. Synchronization depends on a wired or wireless LAN being available to connect the LightSpace application with DaVinci Resolve.

**To synchronize LightSpace CMS to DaVinci Resolve as a pattern generator client:**

1. Open LightSpace on the Windows computer that's running it.

2. When LightSpace is open, click the Network Manager button. A window appears displaying the two network IP addresses used by LightSpace. Note these, and click the Enable button.
3 In DaVinci Resolve, choose Workspace > Monitor Calibration > LightSpace.

4 When the LightSpace dialog opens, enter the second of the two network IP addresses LightSpace lists into the Remote Machine field, and make sure the Port number matches. Then click the Connect button.

![LightSpace Calibration dialog](image)

The Calibration dialog in DaVinci Resolve, connected to LightSpace CMS via WiFi

If everything is working correctly, the LightSpace dialog in DaVinci Resolve should show the word “Connected,” and the Network Manager dialog in LightSpace should show that there is 1 available client/s.

You can now close the Network Manager dialog in LightSpace and follow the procedures outlined in the LightSpace CMS documentation for characterizing your display and building and exporting a display LUT (in the .cube format) that you can use as a display LUT in DaVinci Resolve. Alternately, you can export a display LUT from LightSpace that can be loaded onto an outboard video processing device.

5 When you’re finished, click Disconnect in the LightSpace dialog, and then click Cancel to close the window.

**Viewing Broadcast Safe Exceptions**

Choosing View > Display Broadcast Safe Exceptions sets the Color Page Viewer to show a false-color overlay that indicates in blue the regions of the picture that violate the currently selected broadcast safe level in the Color Management panel of the Project Settings.

![Image with blue highlights](image)

Areas of the image that violate broadcast safe are highlighted in blue

More information about broadcast safe limiting in the Color Management panel of the Project Settings appears in Chapter 127, “Automatic Grading Commands and Imported Grades.”
Comparing Clips in the Viewer

The ability to compare different clips to one another is an important part of the color correction process. DaVinci Resolve provides three different ways of doing so. You can use the Gallery to display two clips for split screen comparison. You can also use different reference modes to see a timeline clip or reference movie directly as part of a split screen comparison. Finally, you can use the Split Screen controls to display multi-frame arrangements in the Viewer.

Saving and Wiping Stills in the Gallery and Timeline

The Gallery on the Color page provides fast access to stills that you’ve saved from various clips in the Timeline. While the dedicated Gallery page provides a more comprehensive interface for browsing presaved “looks,” as well as for importing stills from other projects, you can save, organize, and browse stills directly within the Gallery of the Color page.

Stills are saved in the DPX file format. Once you’ve saved one or more stills, you can set up split screen wipes in the Viewer, which will be mirrored to your external display.

Stills from the Gallery can be compared to the current shot making it easier to match grades

This section provides an abbreviated summary of still store and split screen functionality to get you started quickly.

To save a still, do one of the following:
- Choose View > Stills > Grab Still (Option-Command-G).
- Right-click on the Viewer and choose Grab Still.

To wipe a still, do one of the following:
- Select a still in the Gallery, and click the Image Wipe button on the top Viewer toolbar.
- Choose View > Stills > Play Still (Command-W), or right-click in the Viewer and choose Toggle Wipe.
- Double-click a still in the Gallery.

To adjust a wipe in the Viewer, do one of the following:
- Drag the pointer within the Viewer to move the wipe.
To customize a wipe in the Viewer:

- Click one of the Wipe mode buttons in the Viewer toolbar.

There are the following modes:

- **Horizontal**: Lets you compare both halves of the wipe to either side of a vertical border. Dragging the pointer moves the wipe border left and right.

- **Vertical**: Lets you compare both halves of the wipe above and below a horizontal border. Dragging the pointer moves the wipe border up and down.

- **Diagonal**: Lets you compare both halves of the wipe via an adjustable diagonal border. Dragging the pointer repositions the wipe to the left and right. Hold the option key down and drag while moving the pointer around in a circle to rotate the border of the wipe to any angle you like.

- **Mix**: Lets you blend both images together to compare them. Dragging the pointer controls the fade percentage from one image to the other.

- **Alpha**: Lets you use a qualifier to define transparency in the image of the current clip while comparing it to a Gallery still used as the background. Add a node to the grade and use the qualifier to key a particular color you want to turn transparent (the green of a green screen, for example). Then, connect that node’s KEY output to the Alpha Output that appears in the Node Editor. The part of the foreground image isolated by the key becomes transparent, allowing the Gallery still in the background to show through. This can be useful for previewing how the lighting or grade of a foreground VFX plate looks when the image is composited against a particular background image stored in the Gallery.

- **Box**: Lets you view the current clip as a picture-in-picture effect against the still in the background. Dragging the pointer resizes the crop box around the outside of the reference image.

- **Venetian Blind**: Lets you compare both images being wiped via alternating horizontal strips. Drag the pointer up or down to change the size of the alternating strips. Good for quickly comparing vertical color uniformity, focusing on color and contrast changes that occur from top to bottom.

- **Checkerboard**: Lets you compare both images being wiped via an alternating checkerboard. Drag the mouse left or right to alternate between images by squeezing each check horizontally. Good for comparing color uniformity across the width and height of two images.

- Choose one of the following from either the View > Wipe Style submenu or the Viewer’s contextual Wipe Style submenu.

  - **Wipe Style**: Cycles among the Horizontal, Vertical, Diagonal, Mix, Alpha, Difference, Box, Venetian Blind, and Checkerboard modes.

  - **Invert Wipe**: Reverses each half of the wipe.

**Hover Scrub in the Gallery**

When Live Preview is enabled in the Gallery option menu, the Hover Scrub Preview submenu lets you choose how you want Live Preview to be shown by a thumbnail in the Gallery and in the Viewer when you hover the pointer over a still or LUT in the LUT Browser:

- You can choose to scrub both the thumbnail you’re hovering over and the Viewer, letting you preview the current still’s grade or a LUT over the duration of the current clip in both the thumbnail and Viewer.

- You can choose to scrub just the thumbnail, leaving the Viewer to show just the grade or LUT over the frame at the position of the playhead.

- You can disable scrubbing altogether, in which case both the thumbnail and the Viewer will only show the grade or LUT over the frame at the position of the playhead.
Copying Grades from Stills in the Gallery

Stills also store the grade from the clip they came from, and can be used to copy grades from one clip to another, or to store grades that you might want to use later.

To copy a grade from a still to a clip, do one of the following:

– Select one or more clips in the Timeline, then right-click a still in the Gallery and choose Apply Grade.

– Select one or more clips in the Timeline, then middle-click a still in the Gallery.

When you copy a still in this way, the saved grade completely overwrites the grade in the target clip, unless you’ve used the “Preserve number of nodes” option, found in the contextual menu of the Gallery. For more detailed information on using the Gallery, including options for organizing the Gallery browser, instructions for using Albums, Power Grades, and Memories, as well as other methods of copying grades and performing advanced grade management tasks, see Chapter 138, “Using the Gallery” and Chapter 139, “Grade Management.”

Different Viewer Reference Modes for Wipes

While it’s common to use the Gallery to wipe against reference stills, by changing the reference mode you can also create a wipe against a clip in the Timeline, or against an Offline Reference Clip or Timeline, if one has been assigned to the current Timeline.

To change the Viewer reference mode, do one of the following:

– Choose an option from the View > Reference Wipe Mode submenu.

– Right-click the Viewer and choose an option from the Reference Mode submenu of the contextual menu.

There are three reference modes:

– Gallery: The default reference mode. Lets you wipe the current clip against a Gallery still.

– Timeline: Lets you wipe the current clip against another clip in the Timeline using the Wipe Timeline Clip command (see below).

– Offline: Lets you wipe the current clip against an offline video that’s been assigned to the current Timeline. For more information on assigning Offline References to a timeline for comparison, see Chapter 56, “Preparing Timelines for Import and Comparison.”

Wiping Between Clips in the Timeline

If you want to wipe the current clip against another clip in the Timeline without saving a still to the Gallery first, there’s a special procedure you can follow.

To wipe between two clips using the Timeline reference mode:

1 Click the thumbnail of the first clip you want to compare.

2 (Optional) A “Gang timeline wipe with current clip” option, available from the Viewer option menu, lets you maintain the offset between the current clip and a timeline clip you’re wiping against when you move the current clip selection to other clips. With this option enabled, the offset between the timeline wiped clip and the current clip is maintained when you move the clip selection. You can step the timeline reference clip forward one frame by pressing Command-Option-Right Arrow, and back one frame by pressing Command-Option-Left Arrow. This allows for precise positioning. When this option is disabled, the timeline wiped clip stays where it is regardless of what clip you select.

3 Right-click the thumbnail of the second clip you want to compare against, and choose Wipe Timeline Clip from the contextual menu.

Both clips appear split screened against one another.
NOTE: Wipe Timeline Clip only appears in the contextual menu if you right-click on a thumbnail in the Timeline that has not been selected as the current clip.

Change a Timeline Wipe Using the Timelines Album of the Gallery

While you’re using the Wipe Timeline Clip to show a wipe of the current clip against any other clip in the Timeline, you can open the Timelines album of the Gallery and click different clips to change which timeline clip you’re wiping against (outlined in blue) without changing the current clip (outlined in orange).

Using Split Screen Modes

A set of split screen modes provides additional ways of comparing multiple images in the Viewer at the same time. These provide side-by-side and grid comparisons of multiple shots and multiple versions, all of which are output to video for monitoring on your external video display. For example, you can use the Split Screen Versions mode to display every single version that’s applied to the current clip in a grid, for easy evaluation. The currently selected clip in the Timeline is highlighted in gray, so you can keep track of what you’re doing.

To enable a split screen mode, do one of the following:

- Click the Split Screen button on the top Viewer toolbar, and choose a split screen method from the drop-down menu that appears in the Viewer toolbar at the right.
- Choose an option from the View > Split Screen submenu.
- Press Option-Command-W to turn Split Screen on and off, using the last selected option.
- Right-click the Viewer and choose an option from the Split Screen submenu in the contextual menu.

NOTE: When any of the split screen modes are selected, you cannot see any other onscreen controls in the Viewer, such as Power Window shapes, until you first disable split screen.
Viewing and Choosing the Current Selection

In any of the split screen modes, the current selection is indicated by a gray outline. This outline can be disabled for a more direct comparison by choosing View > Split Screen > Show Outline to toggle the outline off and on.

In certain modes, you can also double-click a particular frame of the split screen view to change the current clip, choose the active version, or apply a gallery grade.

Available Split Screen Modes

You can choose from among the following split screen modes:

- **Current Group:** Shows up to 16 clips that share the same group as the current clip. Double-clicking a frame does nothing in this mode.

- **Highlight Modes:** Shows a four-up display that lets you simultaneously see (clockwise) the clip’s RGB image, the gray matte, the high contrast matte, and a difference matte generated by the node’s input compared against its output. Double-clicking a frame does nothing in this mode.

- **Neighbor Clips:** Shows four clips that immediately surround the current clip. The previous two clips appear as the upper left- and right-hand clips, the current clip appears at the lower left-hand corner, and the next clip appears at the lower right. Double-clicking a frame does nothing in this mode. The “Neighboring Clips in Split Screen” parameter in the Color panel of the User Preferences lets you customize how many neighboring clips appear in this mode.

- **Playheads:** Shows simultaneous comparisons in the Color page Viewer of up to four playheads displayed in the Mini-timeline when you choose multiple playheads from the Color > Active Playhead submenu. For every playhead you expose (up to 4), the frame at each playhead will be displayed in a 2-up, 3-up, or 4-up grid. An outline in the Viewer (if enabled) shows which playhead is currently active. This is useful both for comparing multiple clips, as well as for comparing different frames within the same clip.
- **Selected Album**: When you choose this option, a split screen of the grades of every still in that album are shown in the Viewer as they appear applied to the current clip. Double-clicking a frame applies that gallery grade to the current clip. Up to 16 grades will be shown.

- **Selected Clips**: Shows all currently selected clips in the Timeline, up to 16 at one time. Clicking a clip moves the playhead to the first frame of that clip.

- **Selected LUTs**: Lets you simultaneously display previews of different LUTs effect on the current clip as a split screen in the Viewer by using the LUTs browser to Command-click up to 16 LUTs you want to preview.

- **Selected Still Grades**: When you choose this option, the act of selecting stills in the Gallery of the Color page shows each of the grades associated with those stills as they appear applied to the current clip, in a split screen arrangement. Double-clicking a frame applies that gallery grade to the current clip.
Previewing four gallery grades using the Split Screen > Gallery Grades mode

– **Selected Still Images**: Lets you view the current clip against a variety of other stills in the Gallery that you select. This is not a grading preview, you’re actually doing a split screen of the selected still images in the Gallery.

– **Version**: Shows up to 16 versions for the current clip, all at once, making it easy to evaluate a series of different versions in relation to one another. If you have more than 16 versions, you deserve some manner of award. Double-clicking a version changes the active version.

– **Versions and Original**: Shows up to the first 15 versions for the current clip, along with the original ungraded clip at the upper left-hand corner. Double-clicking a version changes the active version, but you cannot double-click to select the original.

---

**Marker Overlays and Navigation**

If you part the playhead on top of a marker in the Timeline of the Color page, that marker’s information appears in a Viewer overlay, just as in the Edit page, making it easier to read notes and see what information is available. These overlays can be easily hidden by clicking the Viewer option menu and turning off “Show marker overlays.”

**Timeline Marker List Available in Color Page**

**Viewer Option Menu**

The Option menu of the Color page Viewer has a submenu that lists all Timeline Markers in the currently open timeline. This makes it easy to run down client notes.
Using Video Scopes

While not directly tied to use of the Viewers, video scopes nonetheless work hand in hand to help you evaluate the images you’re working on. DaVinci Resolve has a set of five real-time video scopes that you can use to monitor the internal data levels of clips in your project as you work. Each scope provides an unambiguous graphical analysis of different characteristics of the video signal, showing you the relative strength and range of individual color components including luma, chroma, saturation, hue, gamut, white point, and the red, green, and blue channels that, together, comprise the color and contrast of the images in your program.

Video Scope Location

By default, you can view any one of these scopes at a time at the bottom right corner of the Color page, by clicking the Video Scope button in the palette button bar.

Optionally, you can click the Expand button at the top right of the video scope to open the video scopes into a floating window, within which you can display all four video scopes together, or individually, on any monitor connected to your workstation.
Additionally, the video scopes can appear docked on a second display as part of many of the dual-screen layouts available in DaVinci Resolve. However, if you have three computer displays and you’re using dual screen layouts, you still have the option to open the floating Scopes window and place it on your third display, as large as you need.

The video scopes aren’t just available in the Color page. They’re also available in the Media and Deliver pages for whenever you need to evaluate the video signal more objectively, such as when you’re setting up to capture from tape or scan from film, or when you’re setting up for output.

**To open video scopes from the Media, Color, or Deliver pages, do one of the following:**
- Choose Workspace > Video Scopes > On/Off (Command-Shift-W) to open video scopes into a floating window.
- Choose Workspace > Dual Screen > On to open video scopes as part of a dual screen layout.

### Video Scope Measurement Using Scales

Because you’re evaluating the internal state of the image data, by default the numeric scales of the WFM and Parade scopes always reflect 10-bit full range data from 0–1023, regardless of the Video/Data Level setting you’ve selected in the Master Settings panel of the Project Settings. This gives you a window into how the image is being processed by DaVinci Resolve prior to being output via your computer’s video I/O interface.

If you’re working on an HDR (High Dynamic Range) grade, you can choose HDR (ST.2084/HLG) from the Video Scopes option menu (this feature is only available in Studio version). This replaces the 10-bit scale of the Waveform, Parade, and Histogram video scopes with a scale based on nit values (or cd/m2) instead.

![Left] The Parade scope showing the data range scale,
![Right] The Parade scope showing the HDR “nit” scale

### Changing Waveform Scales

A Waveform Scale Style submenu in the Video Scopes option menu (the three dots menu) lets you choose how you want the numeric scale at the left of Waveform and Parade scopes to be represented. There are options for 10-bit display (the default), 12-bit display, Percentage (0 to 100), millivolt (mV), and HDR (ST.2084/HLG). Aside from the added flexibility this gives you, this also means that it’s no longer necessary to go to the Preferences to change the scope to have an HDR scale shown in nits (cd/m2).
Changing Vectorscope Scales

A Vectorscope Scale Style submenu in the Video Scopes option menu (the three dots menu) lets you choose how you want the hue reference indicators to be displayed.

There are four available graticule options:

- **Off**: Disables all graticule overlays in the Vectorscope, giving you a clean view of the Vectorscope graph against black.

- **Standard**: The default layout. Cross hairs indicate the center of the scope, while boxes indicate the center target of each primary and secondary hue (red, magenta, blue, cyan, green, yellow). An outer circle provides a general frame of reference for the angle that any part of the graph might fall along.

- **Simplified**: Shows a crosshairs to indicate the center of the scope and smaller crosshairs to indicate each primary and secondary hue. Useful when you want references without extra complications.

- **Hue Vectors**: A graticule designed to provide a more useful colorist reference for creative decisions and image comparison. This isn’t simply decorative. Graticule lines stretch along the reference angle of each primary and secondary hue from the hue targets to the center, providing a more immediately useful frame of reference when comparing different vector scope graphs to one another. These reference lines fade out within the region of average saturation in most images, so they don’t get in the way of discerning faint details. The center crosshairs are aligned with the red-cyan and yellow-blue axes, indicating the naturalistic warm to cool axis that lies between them. Tic marks indicate both the 75% and 100% levels of image saturation for each hue.

You also have the option of choosing whether or not the primary and secondary hue targets are shown for 75% image saturation, 100% image saturation, or both, and whether or not you want to show the text labels for each hue.
Displaying Scopes With Data or Video Levels

For projects being worked on at video levels, a setting in the video scope option menu’s Waveform Scale Style submenu lets you toggle between displaying video scopes scaled to either Data Levels (the default) or Video Levels (by turning on Video Level Scopes). This only affects how your scopes are displayed; it has no effect on monitored or rendered output.

![Left] The Waveform scope shown at default Data Levels.  
(Right) The same waveform shown with Video Level Scopes turned on

Video Scope Performance and Detail

All video scopes were updated for DaVinci Resolve 16 to show more detail with faster performance than in previous versions. While they’re GPU-accelerated, the video scopes require a certain amount of video processing power to operate. Depending on which combination of video scopes and scope options you have selected, you may notice your real time processing capabilities ever so slightly affected. Closing the video scopes frees up all processing for color correction and effects. On high-powered workstations, you probably won’t notice a difference, but on less powerful computers, closing the scopes might make a small difference.

Two global settings in the video scope option menu affect the performance and detail of all video scopes equally.

– On slower workstations, a quality submenu lets you choose High, Medium, or Low quality scope drawing, to trade off legibility for performance. High quality shows you the most information about the video signal, while an Auto option makes a selection based on your workstation’s capabilities.

![The Quality setting in the video scope option menu]

– All video scopes have a Low Pass Filter setting in the video scope option menu that filters out a signal’s noise to make the scope graphs clearer to read. While this can act as an “x-ray” to better see detail in the scope graph interiors, it can make the highlight and shadow excursions on the graph seem a bit shy of where they actually are, so it’s recommended to enable the “Extents” option of whichever scope you’re using to get an unambiguous look at the maximum excursions in your scopes. Extents draws an outline highlighting all graph excursions to show you the true level of all overshoots and undershoots in the video signal, even when the Low Pass Filter is on.
Display Qualifier Focus in Video Scope Graphs

The Display Qualifier Focus setting in the video scope option menu helps you identify which features in the video image correspond to which parts of the video scopes. With Display Qualifier Focus turned on, choosing the Qualifier mode of the Viewer and moving the eyedropper around the image draws circles around the sampled pixels as they appear in the currently visible video scope graph. If multiple video scopes are visible, each scope will have an indication of the location of the sampled pixels that's specific to each scope.

Explanation of Each Video Scope

There are five available video scopes, each of which shows a different analysis of the video signal you’re adjusting.

Waveform Monitor

Overlays waveform analyses of the Y (luma/luminance), CBCR (the color difference channels of Y’CBCR), or RGB (red, green, and blue) channels over one another so that you can see how they align. The Y option presents a true Luma scope that can have Colorize enabled to show false color, which lets you see which colors in the Viewer image are where in the video scope graph. For the RGB scopes, the relative heights of the red, green, and blue graphs indicate is identical to the description seen for the Parade scope below, and with color enabled the red, green, and blue graphs are tinted with the color they represent. This makes it easy to see where all three graphs align, by looking for where parts of the waveform monitor appear in white, which is the result of the red, green, and blue graphs lining up and adding their color together.
Parade

The Parade scope shows separate waveforms side by side that analyze the strength of individual video signal components. The Parade scope can be set to analyze RGB, YRGB, and Y’CBCR.

By showing a comparison of the intensity of the luma, red, green, and blue channels, the Parade scope makes it possible to detect and compare imbalances by comparing the relative heights of the RGB graphs in the highlights (the top of the R, G, and B graphs), shadows (the bottom of the R, G, and B graphs), and midtones (the middle of the R, G, and B graphs) for the purposes of identifying color casts and performing scene-by-scene correction.

When the YRGB channels are taken altogether, the bottom of all graphs indicates the black point of the image, while the tops of all graphs indicate the white point. It then follows that the difference between the height of the bottom and top of all graphs indicates the overall contrast ratio of the image you’re evaluating. Tall parade graphs indicate a wide contrast ratio, while short parade graphs indicate a narrow contrast ratio.

Vectorscope

Measures the overall range of hue and saturation within an image. Measurements are relative to a centered graticule that you can enable that’s overlaid on the scope, which provides a frame of reference via crosshairs. DaVinci Resolve has a traditional vectorscope, the graph of which emulates a trace-drawn graph, with 75 percent color bar targets indicating the angle of each of the primary and secondary colors around the edge of the graph, and an optional skin tone reference graticule (otherwise known as the In-phase reference).
The Vectorscope can have Colorize enabled to show false color which lets you see which colors in the Viewer image are where in the video scope graph.

More saturated colors in the frame stretch those parts of the graph farther toward the edge, while less saturated colors remain closer to the center of the vectorscope, which represents 0 saturation. By judging how many parts of the vectorscope graph stick out at different angles, you can see how many hues there are in the image, with the specific angle of each part of the graph showing you which hues they are. Furthermore, by judging how well centered the middle of the vectorscope graph is relative to the crosshairs, you can get an idea of whether there’s a color imbalance in the image. If the vectorscope graph is off-centered, the direction in which it leans lets you know that there’s a color cast (tint) in the image.

Histogram (RGB/YRGB parade histogram)
Displays a statistical analysis of how many pixels of each color channel lie at each percentage of tonality, plotted along a digital scale from 0 percent (black) to 100 percent (white). Comparing the left, middle, and right parts of the Y, R, G, and B graphs (Y is optional) lets you evaluate the color balance in the shadows, midtones, and highlights of the image.

Taken altogether, the left of all graphs indicates the black point of the image, while the right of all graphs indicate the white point. It then follows that the difference between the width of the left and right of all graphs indicates the overall contrast ratio of the image you’re evaluating. Wide histogram graphs indicate a wide contrast ratio, while narrow histogram graphs indicate a narrow contrast ratio.
CIE Chromaticity Scope

DaVinci Resolve contains CIE 1931 xy and CIE 1976 uv scopes, which let you see the current image analysis as a graph superimposed against a triangle that represents the tristimulus values of the color gamut you’re working within, along with an indication of the current white point. A label shows the currently selected gamut, with the specific coordinates of these Red, Green, and Blue values as well as the White point, while the overall “horseshoe” shape represents the entire range of visible light, all plotted against an xy graph.

The white point ordinarily appears atop a curve along the center of the shape. This curve indicates the black body locus, along which the various color temperatures of an image’s white point correlate, from orange-ish warm to blue-ish cool. This black body locus corresponds to the color temperatures obtained by progressively heating carbon to different temperatures.

You also have the option of showing a second gamut triangle, in cases where you want to compare the current analysis to two different gamuts. This can be useful when you need to create deliverables in multiple gamuts, and you want to see which parts of the video signal are safe in all gamuts and which parts are exceeding the smaller of the two. When you do this, both gamuts are labeled, and the coordinates of the Red, Green, and Blue values of both gamuts are listed to the side.

In a way, the Chromaticity scope is a 3D scope, but it’s drawn as if you’re looking down at the top of a 3D shape that plots every color value in an image in X, Y, Z space, but you can only perceive the 2D outline around the widest parts of this shape drawn on an X, Y plot. The graph does indeed represent every single value found within a 3D plot of the image data, but the triangle only indicates the widest “slice” of the current gamut and of this 3D shape within the mid-tones.

What this means is that while the Chromaticity scope’s graph gives you a rough idea of whether or not the current image is within gamut relative to your delivery spec, it’s not exact and it’s not foolproof, as part of the image data could fall within this wide triangle and yet overshoot the required gamut elsewhere in the highlights or the shadows near the bottom of the 3D shape you’re looking down on. On the other hand, if any part of the graph does extend past the boundaries of the gamut triangle, then that definitely indicates a gamut violation. You can add an additional gamut triangle in the scope settings in order to compare the color space you’re working in to another color space, for reference.

Most people who’ve had any exposure to color grading concepts are familiar with the traditional CIE 1931 horseshoe graph, which plots the portion of the spectrum visible to the human eye according to studies done in the late 1920s (subsequent studies have confirmed this analysis). The optional CIE 1976 uv graph is based on an updated color space (CIELUV) that was an attempt by the International Commission on Illumination (CIE) to create a more perceptually uniform graph of color. Whereas the CIE 1931 analysis visually exaggerates certain parts of a color graph, the CIE 1976 graph draws all parts of a color graph more or less proportionally to one another. Overall, neither analysis is more “correct” than the other, it’s simply a matter of what you prefer to look at.
Panning and Zooming the Video Scopes

If you want to examine any part of a video scope’s graph in more detail, you can do the following:

– **To zoom into a graph**: Hold the Option key down, and roll the scroll control.

– **To pan around a graph**: Click and drag with the middle pointer button.

Customizing the Video Scopes

Once you’ve opened the video scopes, there are a variety of ways you can customize how the scopes look, and expose additional onscreen graticule information to help you measure what you need.

**Methods of customizing the Scopes window:**

– **To change the size of the Scopes window**: Drag the lower right-hand corner to resize the Scopes window to the desired size.

– **To change how many scopes are displayed at once**: Click one of the buttons in the upper right-hand corner of the Scopes window to set 1, 2, 4, or 9 up arrangements of the video scopes. You can also choose how many scopes are simultaneously displayed by choosing Workspace > Video Scopes > 1-Up, 2-Up, or 4-Up.

– **To change which scopes appear in which pane**: Click the Name drop-down at the upper left corner of each scope’s pane, and choose a different scope. If you like, you can instantiate more than one of each kind of video scope in multi-scope layouts, for instances where you want to view variations on a particular type of scope with different settings. For example, you might want to expose three Vectorscopes, setting each to a different tonal range so you can simultaneously view Vectorscope analyses of Low (shadows), Mid (midtones), and High (highlights).

Once open, you can resize the Scopes window to make it as large or small as you require, positioning on a second display if you want to make it even larger.
To customize each video scope’s display options:

1. Click the Option button to the right of the Scope drop-down menu to expose the current scope’s Custom Controls window.

2. Adjust any of the available controls to customize the look of that particular scope.

3. Click anywhere outside of the Custom Controls window to make it disappear.

Parade Scope Display Options

The Parade scope has the following options:

- RGB, YRGB, and YCbCr modes, allowing you to evaluate more channels than before.
- A colorize checkbox lets you view graphs in monochrome or false-color (indicating red, green, and blue).
- An Extents checkbox draws an outline highlighting all graph excursions, to unambiguously show you all overshoots and undershoots in each waveform.
- The Parade slider makes that scope’s graph brighter or dimmer. Brighter graphs make it easier to see fine detail, but harder to see which parts of the graph are stronger and weaker.
- The Graticule slider makes that scope’s scale brighter or dimmer, making it more or less visible (or distracting) relative to the graph.
- The Show Reference Levels checkbox lets you turn on adjustable Low and High reference level markers by setting the low and high sliders to something other than their defaults. This is especially useful for HDR grading where you’re working within a specific peak luminance threshold.
Waveform Scope Display Options

The Waveform scope has the following options:

- Y (luma) and CbCr (chrominance) modes to show you the true luma or chroma signals in isolation, and RGB to show you only an RGB analysis.
- In RGB mode, R, G, and B buttons that can be individually toggled on and off to see any combination of graphs.
- A colorize checkbox lets you view overlaid graphs in monochrome or false-color (indicating red, green, and blue). If you’re only enabling the Y or C scopes, the different areas of these graphs are drawn with color taken from the image being analyzed, which makes it easier to see which part of the scope graph corresponds to which part of the image.
- An Extents checkbox draws an outline highlighting all graph excursions, to unambiguously show you all overshoots and undershoots in each waveform.
- The Waveform slider makes that scope’s graph brighter or dimmer. Brighter graphs make it easier to see fine detail, but harder to see which parts of the graph are stronger and weaker.
- The Graticule slider makes that scope’s scale brighter or dimmer, making it more or less visible (or distracting) relative to the graph.
- The Show Reference Levels checkbox lets you turn on adjustable Low and High reference level markers by setting the low and high sliders to something other than their defaults. This is especially useful for HDR grading where you’re working within a specific peak luminance threshold.
Vectorscope Display Options

The Vectorscope has the following options:

- Choose ALL to view the entire tonal range of the image as a Vectorscope graph analysis, or to selectively view just the shadows (Low), mid-tones (Mid), or highlights (High) of the image as a vectorscope graph analysis.

- A Colorize checkbox draws the different areas of these graphs with color taken from the image being analyzed, which makes it easier to see which part of the scope graph corresponds to which part of the image. With colorize turned off, graphs only appear white.

- An Extents checkbox draws an outline highlighting all graph excursions to unambiguously show you all overshoots and undershoots.

- A Combine checkbox lets you see simultaneous overlapping extents for the highlights, mid-tones, and shadows overlaid on one another.

- The Vectorscope slider makes that scope’s graph brighter or dimmer. Brighter graphs make it easier to see fine detail, but harder to see which parts of the graph are stronger and weaker.

- The Graticule slider makes that scope’s scale brighter or dimmer, making it more or less visible (or distracting) relative to the graph.

- Low Range and High Range sliders let you manually define the boundaries separating shadows from mid-tones and highlights. Low Range defaults to 0.30, and High Range defaults to 0.70.

- Show 2X Zoom zooms the vectorscope graph by 200%, making it easier to see fine detail and use the vectorscope with charts.

- Show Skin Tone Indicator checkbox shows a line at the traditional Inphase angle that is useful as a general guidepost for average skin tone hue.

- Show Graticule checkbox lets you show or hide the circular degrees indicator surrounding the outer edge and the cross hairs that indicate the center of the vectorscope.
Histogram Display Options

The Histogram has the following options:

- You can view either RGB or YRGB histograms.
- Gain slider scales that scope’s graph taller or shorter. Taller graphs expand to show greater detail in the histogram’s peaks, shorter graphs reduce the apparent detail.
- Graticule slider makes that scope’s scale brighter or dimmer, making it more or less visible (or distracting) relative to the graph.
- The Show Reference Levels checkbox lets you enable adjustable Low and High reference level markers by setting the Low and High sliders to something other than their defaults. These reference markers are especially useful for HDR grading where you’re working within a specific peak luminance threshold.

CIE Chromaticity Display Options

The CIE Chromaticity scope has the following options:

- You can view a chromaticity analysis in either a CIE 1931 xy graph, or a CIE 1976 uv graph.
- CIE Chromaticity slider makes that scope’s graph brighter or dimmer. Brighter graphs make it easier to see fine detail, but harder to see which parts of the graph are stronger and weaker.
– Graticule slider makes that scope's scale brighter or dimmer, making it more or less visible (or distracting) relative to the graph.

– Additional Gamut drop-down menu lets you expose a second gamut triangle, for instances where you want to compare how an image fits into two different gamut ranges.

– Show 2X Zoom zooms the CIE graph and graticule by 200%, making it easier to see fine detail and use the vectorscope with the charts.

– Show Graticule checkbox lets you show or hide the circular degrees indicator surrounding the outer edge and the cross hairs that indicate the center of the vectorscope.
Chapter 126

Color Page Timeline and Lightbox

The Timeline in the Color page, consisting of the Thumbnail Timeline and the Mini-Timeline, is primarily used for navigating the current arrangement of clips, and for keeping track of clip properties such as whether they’re graded and ungraded, whether they use tracking, which version they’re using, and so on. It can also be used for quickly copying grades from one clip to another, for creating groups, and for comparing clips in the Viewer.

The Lightbox is the twin sibling of the Thumbnail Timeline, and provides an image-based method of comparing clips, managing grades, and performing a wide variety of organizational tasks.

This chapter covers the use of the Timeline and Lightbox.

Contents

Navigating Using the Color Page Timeline 2548
Thumbnail Timeline 2548
Mini-Timeline 2548
Using Multiple Timeline Playheads 2549
Show Current Clip With Handles 2550
Thumbnail Info 2550
Thumbnail Contextual Menu Commands 2552
Sorting and Filtering Clips in the Thumbnail Timeline 2552
Changing Timelines 2552
A and C Mode Sorting 2553
Flags, Clip Colors, and Markers 2554
Timeline Filtering 2555
Using the Lightbox 2559
Navigating Using the Color Page Timeline

The Color page Timeline consists of two parts that work together, the Thumbnail Timeline and the Mini Timeline. These work together to let you examine and navigate the Timeline of your program in different ways.

The Color page Timeline

The scroll bar for the Mini-Timeline is independent of the scroll bar for the Thumbnail Timeline, and both can be set to show different ranges of clips. Using the scroll control of your pointing device lets you zoom into or out of the Mini-Timeline. When zoomed all the way out, the Mini-Timeline displays the entire timeline within the available width of the screen, making it a fast way of navigating the entire program from the beginning to the end. However, you can zoom into a particular section when you need more information about how an intricate arrangement of superimposed clips are organized while you’re grading.

Thumbnail Timeline

Provides a concise visual representation of your project where each clip is a single numbered thumbnail, regardless of its duration. Clicking a thumbnail moves the playhead to the first frame of that clip, while using the Up/Down Arrow keys moves the selection to the previous or next clip. Whichever clip is at the current position of the playhead appears with its thumbnail outlined in orange. The scroll wheel of your pointing device lets you scroll backward and forward through the thumbnail timeline.

Mini-Timeline

Shows a miniature representation of the Timeline in the Edit page, where each clip’s width is proportional to its duration, and superimposed clips are shown on top of one another. The Mini-Timeline can show a maximum of six video tracks; if your edit uses more, a scroll bar lets you change which tracks are displayed. Clicking a clip in the Mini-Timeline selects that clip and moves the playhead to its first frame.
Scrolling, Zooming, and Navigation

A Timeline Ruler contains the top handle of the playhead, displays the record timecode of the current edit, and acts as a scrubber bar that typically spans a longer section of the Timeline. The scroll wheel of your mouse lets you zoom in and out of your edit, and if you zoom all the way out you can fit every clip in the Mini-Timeline into the available width of the ruler, letting you scrub through every clip in the Timeline quickly. Clicking anywhere within the ruler instantly jumps the playhead to that frame.

Enabling/Disabling Tracks

The far left of the Mini-Timeline shows numbers for each track, and hovering the pointer over the track number of any track in the Mini-Timeline of the Color page reveals a tooltip showing the name of that track. Clicking a track number enables/disables that track along with all clips on that track, similarly to using the Timeline > Enable/Disable Video Tracks submenu commands (Shift-Command-1 through 9). Clips on disabled tracks are not rendered in the Viewer or video output, and are hidden from the Thumbnail Timeline. If a track has been disabled in the Edit page, it will appear dimmed in the Mini-Timeline.

Option-clicking a track number in the Mini-Timeline turns that track number red, letting you hide clips from the Thumbnail Timeline without actually disabling the video in your program. This is useful in situations where you want to prevent clips in a particular track (such as motion graphics or titles rendered from another application) from intercepting the playhead when using the next/previous clip commands.

Setting In/Out Points for Looping

You can use the I and O keyboard shortcuts to set custom In and Out points in the Timeline. Once set, turning on Loop in the Viewer transport controls enables this range to be looped, whether it's a partial range of one clip, or a range spanning multiple clips together.

Using Multiple Timeline Playheads

DaVinci Resolve supports creating up to four separate playheads in the Mini-Timeline, that you can use to jump back and forth among different parts of your timeline. Only one playhead can be selected at any given time, and the currently selected playhead corresponds to the current clip, highlighted in orange. Each playhead in the Mini-Timeline is labeled with a letter, A through D.

To add a new playhead to the Mini-Timeline:

– Choose a playhead from the Color > Active Playheads submenu. That playhead will be placed at the same position as the original playhead, but it is now the one that is selected, so dragging the new playhead to a new position of the Mini-Timeline will reveal the original playhead you were using.

To select another playhead to view:

– Click on the top handle of any playhead to select it, making that the currently active playhead controlled by the transport controls. By default, no keyboard shortcuts are mapped to the four playheads that are available, but you can create a custom keyboard mapping that you can use to quickly switch among them.

– Using the DaVinci Advanced control panel, you can use the A, B, C, and D buttons on the jog/shuttle panel to switch to the playhead you want to control.
To eliminate all additional playheads from the Mini-Timeline:
– Choose Color > Active Playheads > Reset Playheads.

**Show Current Clip With Handles**

If you’re working on a project that’s part of a round-trip workflow, and you know you’ll be rendering handles for each clip, it can be useful to temporarily expose these handles for the current clip that you’re grading, so you can easily apply tracking or keyframing effects to the full frame range of each clip.

To show or hide clip handles in the Mini-Timeline of the Color page:
– Choose View > Show Current Clip With Handles.

(Left) The current clip in the Mini-Timeline, (Right) The same clip shown with Show Current Clip With Handles enabled

While this mode is enabled, Unmix is turned on and cannot be disabled, in order to let you view the overlapping handles of each clip clearly. The duration of handles that are exposed is defined by the Default Handles Length parameter of the Editing panel in the User Preferences. Clip Handles can be shown or hidden at any time.

**Thumbnail Info**

The thumbnails make it easy to find the clips you’re looking for visually, and they always show the media as it’s currently graded. The most obvious piece of information is the frame that’s used for each clip’s thumbnail. If you feel that a particular clip’s thumbnail isn’t representative of its content, you can change it.

To change the current thumbnail:
– Move the pointer over a thumbnail, drag to the left or right to scrub through the clip, and stop when you find a frame you want to use as the new thumbnail.

Dragging a thumbnail to change the representative image

If media is replaced in the middle of a color correction timeline, or if you copy or ripple a grade to a range of clips, the thumbnails may not immediately update to accurately represent the current state of each clip. In this case, you can manually refresh the thumbnails.

To refresh all thumbnails in the Timeline:
– Right-click anywhere in the Thumbnail timeline and choose Update All Thumbnails.

You can also choose to display the codec, clip names, and version used by each clip in the Timeline.
To switch the Thumbnail timeline between showing clip names, codecs, and versions:

- Double-click the thumbnail clip name of any clip to cycle through each clip’s codec, clip name, and version.

Additional information appears above and below each thumbnail, providing a way of keeping track of which clips have been graded, which clips are using different versions, which clips have been cached, and so on.

The following list explains each piece of information that can appear above, within, or below the thumbnails in the Timeline.

- **Clip number:** (top left) Each clip's number appears above its thumbnail. Clips are numbered in ascending order according to the position of their first frame, from left to right, regardless of the video track in which they appear.

- **Grade indicator:** (top left) If a clip has been graded, a thin rainbow indicator surrounds the clip number.

- **Source Timecode:** (top center) The source timecode from the first frame of each clip appears above each thumbnail.

- **Cache indication:** (red timecode) Any clip that’s marked for caching, whether automatically via the Smart cache, or manually, has its timecode turn red to indicate that it will be cached. After it’s been cached, the timecode turns blue.

- **Track number:** (top right) The video track in which a clip is edited appears above the thumbnail.

- **Clip Color dot:** (upper right) If a clip has a clip color assigned to it, a colored dot appears on top of its thumbnail.

- **Flag icon:** (upper left) If a clip has been flagged, a flag icon of the appropriate color appears on top of its thumbnail. If a clip has multiple flags, as many as can be drawn appear along the top.

- **Linked media or group icon:** (bottom right) If clips are set to use remote versions, and if multiple clips share the same source media file, then by default their remote version 1 grade will be automatically linked. If the current clip is linked, a small link icon appears below the thumbnail of every clip in the Timeline that's also linked to that clip. When you select another clip that’s not linked, the linked clip icons disappear.

- **Tracker icon:** (bottom right) If any node within a particular clip’s grade has been tracked, a small crosshairs tracker icon appears below the thumbnail.

- **3D indicator:** (bottom right) All stereo 3D clips in the Timeline appear with this icon below the thumbnail. The color indicates which eye you’re monitoring; red for the left eye, blue for the right eye.
Version name/Source format: (bottom left) What text is displayed below each thumbnail can be changed by double-clicking the space underneath each thumbnail. There are several options; keep double-clicking to cycle among them:

- **Clip format or codec:** This is what’s displayed by default.
- **Clip Name:** Depending on what View > Show File Name is set to, the clip name or file name is displayed. If you’re working with multicam clips, the multicam angle or name is displayed.
- **Version name or number:** Provides information about whether a clip is using a remote version, or a local version, indicated by an (L). If you’ve given the current version a name, it appears; otherwise the version will be labeled “Version” with its number.

### Thumbnail Contextual Menu Commands

Right-clicking a clip’s thumbnail in the Thumbnail Timeline reveals a contextual menu with many media and grade management commands that are available in the Color page. The available options are divided into the following rough categories:

- Commands for managing grade versions
- Commands for managing groups
- Commands for editing flags, markers, and clip colors
- A command for displaying the Node Graph of a clip’s grade
- Options for controlling the render cache
- Resolve Color Management clip assignments
- LUT Management commands
- A command to fix Black Sun artifacts
- Commands for viewing clip details, editing Clip Attributes, and finding clips in the Media Pool
- A command for updating clip thumbnails that are slow to update on their own

These capabilities are described in more detail in the other chapters of this manual, but it’s important to know that artists working on the Color page have many clip management options available to them, without needing to go to other pages.

### Sorting and Filtering Clips in the Thumbnail Timeline

By default, the Thumbnail Timeline displays every clip of the currently selected edit in the Edit page, sorted in A mode (the record order of your edit). However, the sort order and contents of the Timeline can be changed and filtered to make it easier for you to find specific groups of clips for grading.

### Changing Timelines

If you’re working on a project that has more than one timeline, you can switch timelines right from within the Color page.
To switch timelines in the Color page:

– Choose another timeline from the Timelines drop-down menu at the top of the Viewer.

![Timeline selection at the top center of the Viewer](image)

To switch among timelines using the DaVinci control panel:

– Press the MODES button above the fourth trackball on the Center panel, then press the SWITCH TIMELINE soft key. Press MODES to return to the main page of controls when you’re done.

A and C Mode Sorting

By default, the Timeline is set to Record mode sorting, otherwise known as A mode sorting. In this mode, clips appear in the Timeline according to the order in which they were edited. This lets you see the order of clips as they’ll appear in the final program.

![A Mode sorting, i.e., record order](image)

However, you can change the sort order of the clips in the Timeline to Source mode, or C mode sorting. In C mode sorting, all clips are rearranged in ascending order from left to right according to their source timecode, and their record timecode is temporarily ignored.

![C Mode sorting, i.e., source clip order](image)

Sorting by C mode makes it easy to identify a range of similar clips. For example, if you’re working on a narrative project, clips from each angle of coverage in the scene will naturally cluster together. In another example, sorting by C mode in a documentary will arrange all of a particular subject’s head shots from a specific interview contiguousy, one after another, since they all come from the same range of timecode on the same source tape. In both examples, the close proximity of similar clips to one another that C mode creates makes it easy to copy grades among them, ripple changes, or group them.

When you’re finished, you can switch the Timeline back to A sort mode, and all of the clips will go back to being arranged in the order in which they were edited.
To toggle between A and C mode sorting, do one of the following:

– Choose an option from the View > Timeline Thumbnail Mode submenu.
– Press Command-Page Down to toggle to C mode sorting.
– Press A/C MODE on the T-bar panel of the DaVinci control panel.

While in C mode, the word “SOURCE” appears at the right in the Timeline Ruler of the Mini-Timeline.

A checkbox in the Conform Options group in the General Options panel of the Project Settings lets you change the behavior of C mode sorting. Opening the Settings window and clicking the General Options panel of the Project Settings reveals the Sort Timeline Using Reel Name and Timecode checkbox.

With this checkbox turned on (the default), all clips in the Timeline are sorted by reel name first, and then by source timecode. This way, clips with similar timecode from the same reel will appear next to one another in C mode.

If you turn this checkbox off, reel name is ignored, and all clips in the Timeline are sorted only by source timecode. This may result in clips from multiple sources being mixed together, but it is useful in specific situations.

For example, when grading dailies from a three camera shoot, you may want to see consecutive clips from all three cameras lined up one after the other on the Timeline, so that Cam1_Shot1, Cam2_Shot1, and Cam3_Shot1 appear first, followed by Cam1_Shot2, Cam2_Shot2, and Cam3_Shot2, and so on. In this situation, you don’t want clips from cameras 2 and 3 to be placed at the end of the Timeline simply because of their reel name.

Flags, Clip Colors, and Markers

You have the option of flagging or marking clips in the Color page just like you can in the Edit page, in order to keep track of specific media or frames that you may need to do something to later. For example, you could flag every closeup of a particular actor with a blemish that you want to spend some time fixing with a green flag.
Methods of flagging, changing colors, and marking clips in the Color page:

- **To add a flag to a clip**: Move the playhead to a clip in the Mini-Timeline, and choose a color from the Mark > Add Flag submenu, or Right-click any clip’s thumbnail, and choose a flag color from the Flags submenu. Flags are not frame-specific, so flagging one clip will result in flags also being placed on all other clips that share the same source media in the Media Pool.

- **To remove all of a clip’s flags**: Move the playhead to a clip in the Mini-Timeline, and choose Mark > Clear Flags, or right-click a clip’s thumbnail and choose Flags > Clear All.

- **To change the clip color**: Move the playhead to a clip in the Mini-Timeline, and choose a color from the Mark > Set Clip Color submenu, or Right-click any clip’s thumbnail, and choose a color from the Clip Color submenu. Clip Colors are clip-specific.

- **To remove a clip’s color**: Move the playhead to a clip in the Mini-Timeline, and choose Mark > Set Clip Color > Clear Color, or right-click a clip’s thumbnail and choose Clip Color > Clear Color.

- **To mark a frame of a clip**: Right-click a clip’s thumbnail and choose a marker color from the Marker submenu.

- **To remove a single marker**: Right-click a clip’s thumbnail and choose Delete Marker from the Marker’s submenu. Alternately, you can select the marker in the Mini-Timeline, and press the Delete key.

- **To remove all of a clip’s markers**: Right-click that clip and choose Clear All from the Markers submenu.

**Timeline Filtering**

A drop-down button to the right of the Clips button at the top right of the Color page Interface Toolbar presents preset options for dynamically filtering which clips are shown in the Timeline. This allows you to hide all the other clips in the Timeline except for the subset on which you want to focus.

![Timeline filtering options](image-url)
For example, once you’ve added flags or markers to clips, it’s easy to hide every other clip in the Timeline that doesn’t fit the criteria; for example, hiding clips that don’t have a green flag. This does nothing to alter the original edit, and you can return the Timeline to its original state at any time.

**To filter the Timeline:**

– Click the Timeline Filtering drop-down button to the right of the Clips button at the top left of the DaVinci Resolve UI, and choose an available option. While the timeline is filtered, an orange line appears underneath the Clips button in the UI toolbar at the top of the page.

**To return the Timeline to normal:**

– Click the Timeline Filtering drop-down button, and choose All Clips.

You can use timeline filtering in conjunction with A or C mode sorting to arrange clips in whatever way is best for the task you’re trying to accomplish. Clip filtering can also be used in the Lightbox, and a currently selected clip filtering method will simultaneously isolate clips in the Timeline and Lightbox as you switch back and forth.

**Preset Timeline Filters**

DaVinci Resolve comes with several preset criteria by which you can filter the Timeline, which cover many common organizational workflows:

– **All Clips:** No clips are filtered, and every clip in the current edit is shown.

– **Selected Clips:** Filters all currently selected clips.

– **Graded Clips:** Filters all clips that have been graded.

– **Clips with Fusion Composition:** Clips with Fusion page effects applied to them.

– **Ungraded clips:** Filters all clips that have not yet been graded.

– **Modified clips:** Submenu, filters all clips that have been modified within a specified time.

– **Unrendered clips:** Filters all clips that have not yet been rendered.

– **Flagged Clips:** Filters all clips that have any flag, no flag, or a particular flag; a submenu presents each color.

– **Marked Clips:** Filters all clips that have any marker, no markers, or a particular marker; a submenu presents each color.

– **Keywords:** Filters all clips that have a specific keyword assigned. A submenu presents a list with each keyword that’s used in the Media Pool of the current project.

– **People:** Filters all clips that have a specific person assigned from the People Management Window. A submenu automatically presents a list of each person that’s been identified.

– **Stereoscopic:** Filters stereo 3D clips, a submenu presents options for filtering All Stereo Clips, or just Stereo clips that have been Autoaligned, those with Convergence adjustments, those with Floating Windows adjustments, or stereoscopic clips with swapped media for the left and right eyes.

– **Grouped:** Filters all clips belonging to a particular group, a submenu shows all available groups.

– **Tracked:** Filters all clips with motion tracking.

– **Noise Reduction:** Filters all clips using noise reduction.

– **OpenFX:** Filters all clips using OpenFX.

– **Different Frame Rate:** Filters all clips with frame rates that don’t match that of the project.
– **Edit Sizing:** Filters all clips that have had any Edit Sizing parameters adjusted.
– **Input Sizing:** Filters all clips that have had any Input Sizing parameters adjusted.
– **Common Media Pool Source:** Filters all clips sharing the same source in the Media Pool as the current clip.
– **Matte Nodes:** Filters all clips with an exposed Matte node in the Node Editor.
– **Mattes Available:** Filters all clips with a matte assigned to them, whether they’re used or not.
– **Collaborative Update Available:** (Only available in Collaborative Mode) Filters all clips that have been flagged as having been updated during a collaborative workflow.

**Creating and Using Smart Filters**

If none of the preset filters does what you need, you can create your own custom Smart Filter in order to sift out clips based on any of the intrinsic or user-entered metadata that’s available in the Metadata Editor, Media Pool, and Color page timeline. Smart Filters work much the same way as Smart Bins, and they’re created and edited using the same procedures. For more information on Smart Bins, see Chapter 17, “Adding and Organizing Media with the Media Pool.”

In fact, Smart Filters can be very sophisticated, allowing you to filter the contents of the Thumbnail timeline by multiple criteria, and using multiple groups of multiple criteria for situations where you need to find clips that match all of one set of criteria, but only one of a second set of criteria. In this way, you can create Smart Filters to solve a wide variety of workflow needs as you work in the Color page.

It’s important to point out, however, that as much intrinsic metadata is available to every clip in DaVinci Resolve (clip properties including frame rate, frame size, codec, file name, and so on), the more time you take entering extra metadata in the Metadata Editor to prepare your project for work for editing and grading (for example, entering scene and take information, and keywords for things like character names, day and night, interior and exterior, framing, and so on), the more powerful Smart Filters can be in helping you to sift and sort through the contents of a program you’re grading.

Imagine being able to filter out all the closeups associated with a particular person in a program, or finding all the establishing shots corresponding to a particular location. If you or an assistant can take the time to enter metadata for the source material in a project that identifies these characteristics, you’ll be able to work even more quickly to match shots together and find the clips you need for any given situation.

**To create a Smart Filter:**

1. Click the Timeline Filtering drop-down button to the right of the Clips button at the top right of the DaVinci Resolve UI, and choose Create Smart Filter.
2. In the Create Smart Filter dialog, enter a name for the filter, and use the following controls to create one or more filter criteria (you can have as many filter criteria as you like):

   ![The Create Smart Filter dialog](image)

   – **Show in all projects checkbox:** Lets you create a persistent smart filter that appears in all projects in your database. Smart filters created this way will be found in the User Smart filters section inside every project’s Clips button in the Color page.
– **Match options**: For multi-criteria filtering, choosing All ensures that every single criteria you specify is met for a clip to be filtered. Any means that if only one out of several criteria is met, that clip will be filtered.

– **Filter criteria enable checkbox**: Lets you enable or disable any criteria without having to delete it.

– **Metadata category drop-down**: Lets you choose which category of metadata you want to select a criteria from. Each category of metadata that’s available in the Metadata Editor is available from this drop-down menu. Additionally, Color Timeline Properties (containing many properties unique to the Color page timeline) and Media Pool Properties (containing every column in the Media Pool) provide access to additional metadata you can use for filtering.

– **Metadata type drop-down**: For choosing which exact type of metadata to use, of the options available in the selected metadata category.

– **Metadata criteria drop-down**: Lets you choose the criteria by which to filter, depending on the metadata you’ve selected. Options include “true/false,” integer ranges, date ranges, string searches, flag and marker colors, and so on.

– **Add filter criteria button**: Lets you add additional criteria to create multi-criteria filters. You could use multiple criteria to, for example, find all clips from Scene 2, that also contain the keyword “Diana,” that also have the keyword “CU” in order to find all the Scene 2 close-ups of Diana. Additionally, if you Option-click this button, you can add a nested match option in order to create even more sophisticated filters, where the filter must match all of one set of criteria, and any of another set of criteria.

As you’re editing the filter criteria, the Thumbnail timeline automatically updates to show you how the Smart Filter you’re creating is working.

3 When you’re done editing the filter criteria, click Create Smart Filter. The resulting Smart Filter appears at the bottom of the Filter drop-down menu, and is turned on by default.
Methods of modifying existing Smart Filters:

- **To rename a Smart Filter**: Click the Timeline Filtering drop-down and choose the Smart Filter you want to rename from the Rename Smart Filter submenu, then change the name in the Smart Filter Name dialog, and click OK.

- **To edit a Smart Filter**: Click the Timeline Filtering drop-down and choose the Smart Filter you want to edit from the Edit Smart Filter submenu, then edit the filter criteria, and click OK.

- **To delete a Smart Filter**: Click the Timeline Filtering drop-down and choose the Smart Filter you want to delete from the Delete Smart Filter submenu. It’s immediately deleted.

Using the Lightbox

The Lightbox shows you all clips in the Timeline as a grid of thumbnails, arranged in rows from left to right and top to bottom. This lets you quickly evaluate, compare, and search for clips you want to use when making selections, creating groups, flagging clips, or when scanning for a particular scene or looking for an individual clip.
At the right of the Lightbox is a vertically oriented Timeline Ruler letting you know the timecode value at the beginning of each row of clips. At the top right is a Zoom slider that lets you change the size of the thumbnails.

Selecting a clip in the Lightbox is the same as selecting a clip in the Timeline, and right-clicking a clip in the Lightbox shows the same contextual menu items you’d see if you right-clicked a clip in the Timeline. Furthermore, you can also grade the current clip in the Lightbox using a control panel, or by exposing the color controls to grade the current clip using a mouse or other input device.

Methods of using the Lightbox:

– **To show or hide the Lightbox:** Click the Lightbox button in the toolbar.

– **To show color controls in the Lightbox:** Click the Show Color Controls button in the UI control bar above the Lightbox.

– **To show thumbnail info in the Lightbox:** Click the Clip Info button, which is the second control at the upper left-hand corner of the Lightbox, to turn each clip’s thumbnail info off and on.

– **To resize clips in the Lightbox:** Drag the Zoom slider to the right to increase thumbnail size, or to the left to decrease thumbnail size.

The contents of the Lightbox can be filtered using the same options that are available for filtering the Thumbnail timeline.

To filter the Lightbox:

1. Click the Show sidebar button at the upper left-hand corner of the Lightbox. This reveals all of the filtering options that are available in the Lightbox, including custom Smart Filters you’ve created.

2. Click one of the options appearing in the sidebar. The Lightbox should immediately update to show just those clips that match the selected criteria.

3. To go back to seeing every clip in the Timeline, click All Clips.
The Lightbox can also be output to video, in order to see its contents on a broadcast display or projector.

To output the contents of the Lightbox to video:
- Click the Output Lightbox to Video button at the upper right-hand corner of the Lightbox.

For more information about clip selections, groups, and grade management, see Chapter 139, “Grade Management.”
While DaVinci Resolve has a wide variety of manual grading controls that afford you control over just about every component of digital imagery, DaVinci has spent a lot of time investigating ways of increasing colorist efficiency by creating automated grading tools. Furthermore, with integrated editing bringing professional editors into the world of editing, grading, and finishing in DaVinci Resolve, the same automated tools being developed to help colorists go home earlier can also be used to give non-colorists a hand in taking care of simple grading tasks.

Contents

- Color Match Palette 2563
- Tips for Properly Shooting a Color Chart 2564
- How to Use Color Match 2565
- Configuration Controls 2567
- Reset Controls 2567
- Automatic Adjustments in the Primaries Palette 2567
- White Balance Eyedropper 2567
- Pick Black Point and Pick White Point 2568
- Auto Color 2569
- Shot Match 2570
- Shot Match Guidelines 2571
- How to Use Shot Match 2572
- Suggestions for Using Shot Match 2573
- Broadcast Safe 2573
- Black Sun Highlight Correction 2574
- Using CDL Grades 2575
- Using ARRI Looks 2575
Color Match Palette

If the camera and lighting departments had the foresight to shoot a color test chart for each of the major lighting setups in the project you’re grading, DaVinci Resolve lets you superimpose a sampling grid over a chart in a clip and mathematically analyze the sampled colors to generate an automatic correction. Using controls in the Color Match palette, you can specify the Source Gamma, Target Gamma, and Target Color Space to make sure that the resulting correction is correct for the camera you used, and the project you’ve set up.

The Color Match palette works with several standardized color charts:

- Datacolor SpyderCheckr 24
- DSC Labs ChromaDumonde 24+4
- DSC Labs SMPTE OneShot
- X-Rite ColorChecker Classic
- X-Rite ColorChecker Classic - Legacy
- X-Rite ColorChecker Video
- X-Rite ColorChecker Passport Video

The X-Rite ColorChecker, Datacolor SpyderCheckr, and DSC Labs SMPTE OneShot charts compared, all of which are supported by the Color Match palette.

The result is analyzed to generate an automatic color correction to use to create a neutral grade for the image, to use as a starting point for the rest of your grade.
Tips for Properly Shooting a Color Chart

The results you get using Color Match are completely dependent on how the charts were shot in the field. If the charts were properly shot, you’ll get great results. If the charts were improperly shot, the results will be unpredictable.

To get the best results using Color Match, adhere to the following guidelines:

– The chart must be lit evenly such that the lighting on each patch is the same intensity (level) and color. Any shadows or changes in lighting color across the chart will result in Color Match trying to compensate for these changes, and an inaccurate match will result. When viewing a chart being lit prior to a shoot shooting via a waveform monitor, the top of each individual patch as seen on the scope should appear as a rectangle with a “flat top.”

– No patches on the chart should be clipped in any of the RGB color channels. A clipped channel will force Color Match to use incorrect RGB values, and the resulting match will be inaccurate.

– The white patch on the recorded chart should be captured between 70–95 IRE/percent. Correct exposure is essential to getting a good result, and while Color Match does allow for some adjustment via the White Level option, this will only give accurate results if the original chart is shot so that the white patch sits within the 70–95 IRE/percent range when viewed on a waveform monitor. It is not recommended that a white patch be shot with a signal level above 95 IRE/percent, since this usually means that one of the RGB channels is close to or actually clipping which will cause an inaccurate match.
– The Source Gamma setting must be set to match the encoded OETF (opto-electrical transfer function, or gamma) of the recorded image. To be able to create an accurate adjustment, the Color Match function requires image data that is scene linear (linear to light). Most captured or recorded image data is encoded with a tone curve (gamma curve) to maximize the efficiency of the bit depth being used, and different cameras use different gamma curves to maximize the image data from different sensors. Since the Color Match algorithm converts image data into a scene linear space before creating an adjustment, it needs to undo the gamma curve created by the camera or debayering process. If the wrong Source Gamma setting is selected in the Match Color palette, then the data will not be linearized correctly and the resulting match will be inaccurate.

– Lighting in the scene with an unusual spectral response or a strong color cast can cause an inaccurate match. Scenes lit with lights that have an unusual spectral response (such as cheap fluorescent bulbs, cheap LED lighting, or mercury vapor fixtures that exhibit a very narrow or spiky spectral power distribution) can cause metameric errors in both the camera’s response and the Color Match function, resulting in the creation of an inaccurate adjustment. The most accurate results are obtained when the scene uses lighting with a chromaticity that is close to the black body locus (with a highly correlated color temperature) and a relatively smooth spectral power distribution. In other words, use high-quality lighting that doesn’t have spikes in specific parts of the spectrum.

– Large differences between the color temperature of the lighting shining directly on the chart and ambient lighting elsewhere in the scene can cause perceptual errors. Often the problem is one of perception and not an incorrect color adjustment. For example, outdoor scenes being artificially lit with instruments shining extremely warm light (low color temperatures of 3200K or less) but that have cooler ambient lighting may appear overly blue if matched with a Target Color Temp of 6500K. This happens because the chart under direct lighting is lit at the lower (yellower) color temperature, but areas of the scene in shadow are much cooler because of the ambient “blue” light from the sky; the result is an automatic color adjustment that’s correct for the chart, but exaggerated in the background.

How to Use Color Match

The following procedure shows how to use the Color Match palette and overlay to create a color correction.

To sample a color chart to make an automatic correction:

1 Select the clip with a chart you want to sample. If necessary, you can use the View > Show Current Clip With Handles option to show additional frames at the beginning of the current clip to reveal a color chart in the leader of your media.
2 If necessary, choose an option from the Source Gamma drop-down menu that corresponds to the gamma with which the media was recorded.

3 Then, choose a target gamma and color space that corresponds to the format you want this clip to be matched to.

4 Click the Viewer tool drop-down, choose the Color Chart overlay, and use its corner-pinning controls to line the sampling boxes up with the color patches of the chart.

5 When you're finished, click the Match button, and the clip will be automatically corrected.

**TIP:** Keep in mind that not every shot needs to have a chart. If the lighting of the location used in a scene is consistent, you really only need a single chart analysis to generate a correction that you can copy to all other clips in the same scene. Of course, if you are using multiple cameras in a scene, you should have a chart analysis for each separate camera if you want to try and match them more closely together. If you’re shooting a scene that takes all day, you may also want to shoot charts at significant time changes corresponding to the lighting changes that are happening.
Configuration Controls

Here’s a more detailed explanation of each of the parameters found in the Color Match palette.

– **Source Gamma:** Defines the source gamma the media was recorded with. You must select the correct gamma or the results will not be as accurate.

– **Target Gamma:** Lets you select a target gamma that you want the corrected clip to use. While this will most likely be the gamma you’re outputting the finished program at, you can choose other target gamma values for specialized workflows.

– **Target Color Space:** The color space you’ll be outputting the finished program with.

– **Color Temp:** An adjustable color temperature control that lets you manually adjust the target color balance of the resulting correction to be warmer (lower values) or cooler (higher values). The default is 6500K.

– **White Level:** A checkbox that’s disabled by default, which lets you manually choose the target white point that the automatic correction should use. Raising or lowering this value will stretch or compress the contrast of the final correction.

– **Match button:** Once you’ve chosen the appropriate settings, and aligned the color match target with the chart that was recorded, click to execute the match.

– **Chart type drop-down menu:** You can choose from among the supported chart types in this drop-down. At the time of this writing, these include the Datacolor SpyderCheckr24, theChromaDuMonde 24+4, the DSC Labs SMPTE OneShot, the X-Rite ColorChecker Classic, the X-Rite ColorChecker Classic - Legacy, the X-Rite ColorChecker Video, and the X-Rite ColorChecker Passport Video.

– **Reset All button:** Resets all controls and adjustments in this palette.

Reset Controls

The Color Match option menu has a variety of commands you can use to reset your work in the Color Match palette.

– **Reset Match Configuration:** Resets the Configuration parameters described above.

– **Reset Applied Match:** Resets the matching operation without resetting the Configuration controls.

Automatic Adjustments in the Primaries Palette

There are four controls found in the Primaries palette that can be used for automatically making different color adjustments, in order to give you a head start whenever you’re trying to neutralize a color cast in the image or choose better black and white points for exposure.

**White Balance Eyedropper**

The White Balance eyedropper, found at the bottom-left corner of the Primaries palette next to the Automatic Correction button, provides an automated way of neutralizing a color cast in your image that you can guide by manually selecting a feature in the image that is supposed to be white.
To auto white balance an image with an undesirable color cast or tint:

1. Click the White Balance eyedropper button. The pointer turns into the White Balance eyedropper.

   ![The White Balance eyedropper](image)

2. In the Viewer, click on any feature that is supposed to be white such as a white wall, white trim around a window, white blinds, a white shirt, and so on. As you drag the eyedropper around, the RGB values appear as a tooltip to give you a better idea of what the color is of the feature you’re about to click on. Make sure the feature you click on is (a) supposed to be white, and not off-white, and (b) that it corresponds to an image detail that’s not clipped, because that can make parts of the image seem white that aren’t really.

   As a result, the white balance of the image should appear much more neutral than before. Note that this adjustment is not applied via any of the controls in the Primaries palette; it’s an invisible, self-contained adjustment.

Pick Black Point and Pick White Point

The Pick Black Point and Pick White Point eyedropper controls, found at the upper left-hand corner of the Lift and Gain controls of the Wheels and Bars modes of the Primaries palette, let you adjust contrast by lowering the black point or raising the white point of the image, and also correct for unwanted color casts in the shadows or highlights of the image.

**NOTE:** It’s easy, using the Pick Black and White Point controls, to inadvertently boost the highlights or lower the shadows so much that you end up clipping part of the image. To give these controls the best chance of succeeding, it’s advisable to find the absolute brightest or darkest parts of the image to sample, according to the following instructions.

To automatically adjust the black point of an image:

1. Click the Pick Black Point control. The pointer turns into the Black Point tool.

   ![The Auto Pick Black Point control](image)

2. In the Viewer, click on any feature that is supposed to be black such as the deepest part of a shadow in the background or within a fold of clothing, black fabric, or something painted black. As you drag the Black Point tool around, the RGB values appear as a tooltip to give you a better idea of what the color is of the feature you’re about to click on. Make sure the feature you click on is (a) supposed to be black, and not some very dark hue, and (b) that it corresponds to an image detail that’s not clipped, because that can make parts of the image seem black that aren’t really.

   As a result, the darkest parts of the image should appear much darker than before, and any color imbalance in the shadows should be neutralized. Unlike the White Balance eyedropper, this adjustment is applied via the Lift controls in the Wheels and Bars mode, which should appear with some manner of adjustment as a result.
To automatically adjust the white point of an image:

1. Click the White Point control. The pointer turns into the White Point tool.

2. In the Viewer, click on any feature that is supposed to be white such as a white wall, white trim around a window, white blinds, a white shirt, and so on. As you drag the White Point tool around, the RGB values appear as a tooltip to give you a better idea of what the color is of the feature you’re about to click on. Make sure the feature you click on is (a) supposed to be white, and not off-white, and (b) that it corresponds to an image detail that’s not clipped, because that can make parts of the image seem white that aren’t really.

As a result, the lightest parts of the image should appear much lighter than before, and any color imbalance in the highlights should be neutralized. Unlike the White Balance eyedropper, this adjustment is applied via the Gain controls in the Wheels and Bars mode, which should appear with some manner of adjustment as a result.

Auto Color

The Auto Color command provides a quick way to automatically balance the blacks and whites of a clip based on the current frame at the position of the playhead. As of DaVinci Resolve 16, the A button in the Primaries palette and the Shot Match command available from the Thumbnail Timeline contextual menu both now use advanced algorithms, based on the DaVinci Neural Engine, to provide superior results when automatically adjusting color balance and contrast. These controls have been developed to provide optimal results when working in the Rec. 709 color space, and at a gamma of 2.4, so they work well in conjunction with using Resolve Color Management (RCM) to normalize media first.

- The A button performs an automatic analysis of the current frame at the playhead to give a more consistently useful neutral starting point for further adjustment.

- The Shot Match command matches one or more clips to the color and contrast of a graded or ungraded target clip. This updated version of Shot Match has been designed to be used after you’ve used the A button on each clip in the operation, the clips you’re matching and the clip you’re matching to.

If you’re in need of a fast neutral starting point for a range of clips, you can also use these commands together, grading a target clip using the A button, and then using Shot Match to match a range of clips in the same scene to the automatically graded example. Please note that these commands are intended to provide you with a reasonably neutral starting point for continued grading; they’re not meant to create creative or artistic grades.
To make an automatic correction, do one of the following:

– Open the Primaries palette to any mode, and click the A button in the lower left-hand corner.
– Choose Color > Auto Color (Option-Shift-C).
– Press the AUTO COLOR button on the T-bar panel.

The advantage of Auto Color is that it gives you an immediate result for any clip without the requirement for sampling the image or having a specific test pattern to analyze, but the disadvantage is that this lack of guidance makes the usefulness of this command somewhat hit-or-miss. When it works, it can work very well to give you a neutral starting point for further grading. When it fails, you’re better off resetting the resulting adjustment and grading the old fashioned way.

**Legacy Auto Color**

The previous methods for doing Auto Color and Shot Match are available from the Color panel of the User Preferences, via two checkboxes named “Use Legacy Auto Color/Shot Match.” With these enabled, DaVinci Resolve looks for the darkest levels in the image to neutralize the RGB color balance in the blacks, and the brightest levels to neutralize the RGB color balance in the highlights. Furthermore, Master Lift and Master Gain are adjusted to maximize image contrast at the outer boundaries of 0 and 100 percent. Using this control with the Primaries Bars mode open makes it easier to see what’s been changed after these automatic adjustments are made.

**Shot Match**

The previously available automated color correction commands, Auto Color and Color Match, are both useful for adjusting a selected clip to give it a clean, neutral starting point when you’re either in a hurry, or if you’re having trouble manually working out a solution. However, this is only the first step in grading a scene.

After you make a general adjustment to improve the color of a clip in a scene, one of the other principal tasks of the colorist is to adjust all of the clips in that scene so that they match the clip you started with, such that they all look like they were shot at the same time and in the same place. This is called scene-to-scene color correction, scene balancing, or shot matching. While there are abundant tools in DaVinci Resolve to ease the process of doing this manually, wouldn’t it be nice if you could just select a series of clips that you want to match, and have the software do the work?

That’s exactly what Shot Match has been designed to do. Whether you’re a colorist in a hurry, trying to blast through a low-budget feature with an absurd schedule, a DIT making best light dailies who just wants to make them match a little more closely before sending media off to editorial, or an editor who isn’t fast at color correction who needs to give a rough cut a quick color balance before showing the project to the client for the first time, the Shot Match feature of DaVinci Resolve has been created to quickly make different clips in a timeline match one another more closely, with a minimum of steps.

As of DaVinci Resolve 16, the Shot Match command available from the Thumbnail Timeline contextual menu uses an advanced algorithm, based on the DaVinci Neural Engine, to provide superior results when automatically adjusting color balance and contrast. This control has been developed to provide optimal results when working in the Rec. 709 color space, and at a gamma of 2.4, so they work well in conjunction with using Resolve Color Management (RCM) to normalize media first.

The updated version of Shot Match has been designed to be used after you’ve used the A button on each clip in the operation, on both the clips you’re matching and the clip you’re matching to.
Legacy Auto Color

The previous methods for doing Auto Color and Shot Match are available from the Color panel of the User Preferences, via two checkboxes named “Use Legacy Auto Color/Shot Match.” With these enabled, DaVinci Resolve looks for the darkest levels in the image to neutralize the RGB color balance in the blacks, and the brightest levels to neutralize the RGB color balance in the highlights. Furthermore, Master Lift and Master Gain are adjusted to maximize image contrast at the outer boundaries of 0 and 100 percent. Using this control with the Primaries Bars mode open makes it easier to see what’s been changed after these automatic adjustments are made.

Shot Match Guidelines

Keep in mind that Shot Match isn’t supposed to make your clips look good, it’s supposed to make them look the same as the clip you choose to match to, or to at least get as close as possible without creating a color correction that will do harm to the image. The purpose of Shot Match is to make it easier for you to match a scene’s worth of clips together so you have a starting point for building the rest of the look you want for that scene, on top of this initial match.

The clip you choose to match to may have a correction applied to it, but for the best results, you should limit yourself to simple Lift/Gamma/Gain primary adjustments. If you make Custom curve or secondary adjustments to the image, it will be much more difficult for Shot Match to give you a good result.

Shot Match works best with normalized clips. If you’ve got a timeline edited with log-encoded clips, you may want to use DaVinci Color Management to normalize all the clips in the Timeline before you use Shot Match, to get the most accurate results. It’s certainly possible to use Shot Match with log-encoded media, but the flat color signal of log-encoded media may make it harder to get good results, depending on the scene.

Furthermore, Shot Match is not the right tool to use to try and match un-normalized log-encoded clips that use different types of log encoding, such as LogC and RedLogCine, or to try and match normalized and un-normalized clips. Because log-encoding is similar to a set of red, green, and blue curve operations, Shot Match is not equipped to achieve a successful result in this situation.

Shot Match is not designed to apply corrections to clips that already have node adjustments. The results will be unpredictable, and probably won’t match. While the clip you’re matching to may have simple primary adjustments applied to it, the other selected clips that are being matched should be completely ungraded.
Lastly, Shot Match has been designed to do no harm to the image. This means if you use Shot Match to try and match an underexposed interior shot to an exterior shot exposed at high noon on a sunlit day, the Shot Match algorithm will do its best to “split the difference” in order to make the difference between these two clips less jarring, while at the same time taking care not to stretch the color and contrast adjustments being made to the underexposed clips to the point where the image falls apart.

How to Use Shot Match

There’s no way to easily describe what Shot Match does. It’s a complex algorithm designed to try and deal with an impossibly varied number of different situations. As a result, Shot Match doesn’t apply adjustments to any of the user-editable controls in the Color page. Instead, the image adjustment created by Shot Match is applied invisibly, as the very last adjustment to the node that was selected when Shot Match was used, similar to a LUT.

How to Use Shot Match

The procedure for using Shot Match is deceptively simple. However, getting a good result requires some careful thought in terms of choosing which clips to match to one another.

To match one or more selected clips to a specific clip:

1. Following the guidelines presented in this section, Command-click or Shift-click one or more clips that you want to be matched. The clip you want to match to may or may not be part of the selection. You may select as few as one clip, or as many as you like.

2. Next, right-click the clip you want to match all of the selected clips to, and choose Shot Match to This Clip.
If the resulting automated match looks good and plays well, then congratulations, you’ve got an excellent starting point for additional grading. However, keep in mind that even if the resulting match isn’t perfect, it may have taken care of enough inconsistencies between the clip you’re matching to and the clips that are being matched, that you need only make smaller, easier-to-spot adjustments in order to nail the final match between the shots in a scene. Either way, you can save time.

Suggestions for Using Shot Match

It’s certainly possible to select every clip in a scene and use Shot Match, and the results may be wonderful depending on what kind of visuals are in the scene. However, for other scenes, this may not always get you the best results.

Be strategic about which clips you select to match to one another. Don’t use Shot Match on shots that you know already have the same lighting, as you’ll risk having Shot Match make a minor adjustment that may actually make the shots match less well. Think of Shot Match as a tool for matching clips that look different.

It can also help to use Shot Match an angle at a time, and to do a small test before committing yourself to matching a bunch of clips. For example, suppose you have a scene consisting of angle A (an over of character 1), angle B (an over of character 2), and angle C (a master shot), and you want to match the entire scene to angle C since it has the best lighting. First, match one shot from angle B to your favorite shot from angle C, and see how you like the result. If it’s good, then go ahead and select every angle B clip and match them to angle C, before moving on to test one shot from angle A. This way, if there’s ever an angle that doesn’t work well using Shot Match, you can try matching it to one of the other angles in the scene that you’ve already matched to see if you get a better result.

**NOTE:** Keep in mind that, since each clip in the Timeline has its own undo stack, you cannot undo a shot match operation applied to multiple clips all at once.

Beware of clips with large areas of color in the background that don’t match any of the other angles in a scene, such as a shot-reverse-shot sequence that cuts between someone standing in a back yard and someone standing against a purple wall. You can try it to see what happens, but this kind of color distribution can often throw Shot Match results off.

**Broadcast Safe**

If you regularly deliver to restrictive QC standards, then you can enable Broadcast Safe in the Color Management panel of the Project Settings while you grade to limit both the luma and chroma of the video signal to one of three levels of acceptable overshoots and undershoots.

---

The Broadcast Safe parameters in the Color Management panel of the Project Settings

- **Broadcast safe IRE (mV) levels**: A drop-down menu for choosing one of three levels of aggressiveness when limiting the signal. Choose the range that corresponds to your QC requirements. The options are “–20 - 120” (permissive), “–10 - 110” (conservative), and “0 - 100” (very conservative).
- **Make Broadcast Safe**: A checkbox that turns broadcast safe limiting on and off.
**NOTE:** The clipping imposed by Broadcast Safe itself does not have an inherently soft roll-off. For best results, Broadcast Safe should be used in conjunction with the Soft Clip controls in the Color page, or a Soft Clip LUT. For more information see Chapter 4, “System and User Preferences.”

### Black Sun Highlight Correction

If your project uses media shot with one of the Blackmagic Cinema, Production, Pocket, or Ursa cameras, and you have clips that exhibit so-called “black sun” artifacts, where bright onscreen highlights appear with a dark magenta spot, a command exists to quickly and easily remove these artifacts.

(Top) Black Sun artifact seen in image; (Bottom) Artifact removed using Black Sun Highlight Correction

**To remove black sun artifacts from Blackmagic camera footage:**

- Right-click the affected clip’s thumbnail in the Thumbnail timeline of the Color page, and choose Black Sun Highlight Correction from the contextual menu.

The command for removing black sun artifacts
Using CDL Grades

Only available in DaVinci Resolve Studio.

There are two instances where primary grading adjustments may be applied to a clip outside of adjustments that you make within the Node Editor of the Color page. If you import a CDL (Color Decision List), then the CDL adjustment for each clip is made available to you via a contextual menu command in the Thumbnail timeline of the Color page. For more information, see Chapter 146, “Copying and Importing Grades Using ColorTrace.”

Using ARRI Looks

Only available in DaVinci Resolve Studio.

If you’ve ingested ARRIRAW media or QuickTime-wrapped Apple ProRes from an Amira, Alexa SXT or Alexa LF, or MXF-wrapped Apple ProRes from Alexa Mini LF with embedded ARRI Look metadata (CDL + LUT), the embedded look can be copied to the currently selected node in the Color page.

To copy an ARRI look from the source media to the current node:

1. Select a node in the Node Editor to which you want to apply the look data.
2. Right-click that clip’s thumbnail and choose Apply ARRI CDL and LUT. A LUT and Color Wheels adjustment will be applied to the selected node.
Chapter 128

Camera Raw Palette

The Camera Raw palette lets you make clip-specific adjustments to the parameters that are used to debayer a raw clip into an image that can be graded in DaVinci Resolve.

Contents

- Introduction to the Camera Raw Palette 2577
- Copying, Versioning, and Protecting Camera Raw Settings 2577
- Making Changes to Clip Camera Raw Settings 2578
- Clip Decoder Settings 2579
- Resetting Camera Raw Settings 2580
- Updating Sidecar Settings for Blackmagic RAW (BRAW) Clips 2580
Introduction to the Camera Raw Palette

When a timeline uses clips that are linked to camera raw source media recorded from cameras from Blackmagic Design, RED, ARRI, Sony, and Vision Research, all clips in raw media formats are initially debayered using the settings found in the Camera Raw panel of the Project Settings.

However, if there are individual clips that you want to apply different raw settings to, for example altering the ISO to pull more detail out of the highlights or shadows, then you can use the controls found in the Camera Raw palette to individually alter the parameters found within.

The Camera Raw palette showing the available parameters for Blackmagic RAW media.

The Camera Raw palette is automatically set to the mode (seen within the Mode drop-down menu) that is appropriate to the clip that’s currently selected. If the current clip is not in a raw format, then the parameters within the Camera Raw palette are disabled.

All settings that currently populate the Camera Raw palette are also accessible from the DaVinci control panel.

To access camera raw settings on the DaVinci control panel:

1. Press the CAMERA RAW soft key on the Center panel.
2. Use the Center panel knobs to make camera raw parameter adjustments.
3. When you’re finished, press the MAIN soft key to return to the main page of controls.

This section covers general use of the Camera Raw palette. For in-depth documentation about specific camera raw parameters, see Chapter 6, “Camera Raw Settings.”

Copying, Versioning, and Protecting Camera Raw Settings

Ordinarily, a clip’s camera raw settings are copied along with its grade, or saved inside stills grabbed from that clip, when you use the various grade management techniques covered in Chapter 139, “Grade Management.”

When you create new versions, you copy the current Camera Raw settings to the new version, but any changes you make are specific to that version, so each version can have individual Camera Raw adjustments. For example, you could compare the results of two different camera raw adjustments on the same clip.
If you’re copying and rippling grades among multiple clips, you can also protect each clip’s camera raw settings from being overwritten using the “Copy Grade: Preserve Camera Raw Settings” option found in the contextual menu of the Gallery. For more information on the Copy Grade settings, see Chapter 139, “Grade Management.”

**Making Changes to Clip Camera Raw Settings**

If you want to make individual adjustments to a particular clip’s camera raw settings, choose “Clip” from the Decode Using drop-down menu in the Camera Raw palette. This makes all the parameters in the Camera Raw palette editable, and changes you make override the project-wide camera raw settings.

Changes to the parameters in the Camera Raw palette can also be rippled across multiple clips at once.

**To ripple camera raw adjustments across multiple clips:**

1. First, you must select a range of clips in the Color page timeline.

2. Open the Camera Raw palette, and make whatever adjustments are necessary to the current clip. The name of each parameter you adjust changes to amber, showing you which parameters have been modified, and which have not.

3. To ripple your changes, do one of the following:
   - Click the Use Changes button to ripple only the altered parameters (in amber) to the other clips you’ve selected in the Timeline. This preserves differences between clips in the parameters you haven’t adjusted (in gray).
   - Click the Use Settings button to ripple every parameter of the current clip to the other clips you’ve selected, overwriting all the camera raw settings at once.
Clip Decoder Settings

There’s much more information on the various format-specific Master settings, as well as the occasionally format-specific Clip Decoder settings, in Chapter 6, “Camera Raw Settings.” However, with the exception of the RED Clip Decoder settings that appear for R3D clips, most other formats share a set of DaVinci Resolve-specific controls that provide wide-latitude access to the raw image data for purposes of making different kinds of adjustments.

While specific raw formats have individual controls, the standard controls include:

- **Color Temp**: Designed to alter the “warmth” of the image. Adjustable in degrees Kelvin. Lower values correct for “warmer” lighting, while higher values correct for “cool” lighting. +6500 is unity. The range is +2000 to +50,000.

- **Tint**: Color balance correction for images with a green or magenta color cast, such as fluorescent or sodium vapor bulbs. 0 is unity. The range is –150 to +150.

- **Exposure**: Increases or lowers image lightness in units relative to f-stops. If your intended exposure adjustment lifts image data above the maximum white level, don’t worry; all image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –5 to +5.

- **Sharpness**: A debayer-specific sharpness filter applied to provide the appearance of enhanced image detail. 20 is unity. The range is 0 to 100.

- **Highlights**: Makes it easy to selectively retrieve blown-out highlight detail in high-dynamic-range media by lowering this parameter, and achieves a smooth blend between the retrieved highlights and the unadjusted midtones for a naturalistic result. 0 is unity. The range is –100 through +100.

- **Shadows**: Lets you selectively lighten or darken shadow detail. Raising this value retrieves shadow detail recorded below 0 percent, while leaving the midtones alone. 0 is unity. The range is –100 through +100.

- **Color Boost**: A non-uniform saturation operation that affects regions of low saturation more than regions of high saturation. This is sometimes referred to as a vibrance operation. 0 is unity, showing the original color values. Raising color boost from 0-100 increases color intensity, but low-saturation parts of the image are raised more aggressively. Lowering Color Boost from 0 to -100 decreases color intensity, but low-saturation parts of the image are lowered more aggressively. 0 is unity, showing unaltered saturation. The range is –100 through +100.

- **Saturation**: A uniform saturation operation that raises (above 50) or lowers (below 50) the color intensity of every color value within the image. 50 is unity, showing unaltered saturation. The range is -100 (completely desaturated) through +100 (saturation is doubled).
– **Midtone Detail**: When this parameter is raised, the contrast of regions of the image with high edge detail is raised to increase the perception of image sharpness, sometimes referred to as definition. When this parameter is lowered to a negative value, regions of the image with low amounts of detail are softened while areas of high-detail are left alone. 0 is unity. The range is –100 through +100.

– **Lift**: Adjusts the black point of the media, raising it or lowering it while scaling all midtone values between it and the white point. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. The range is –100 to +100.

– **Gain**: Adjusts the white point of the media, raising or lowering it while scaling all midtone values between it and the black point. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

– **Contrast**: Raising contrast reduces shadows and raises highlights, while leaving midtones at 50 percent unaffected. Regardless of how you adjust this control, all image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

### Resetting Camera Raw Settings

If you’ve made changes to the parameters of the Camera Raw palette and you decide you need to reset them, there are two options, found in the Options menu.

– **Reset**: Resets all parameters in the Camera Raw palette to their default settings.

– **Revert**: Similar to the “Original Memory” command, Revert changes all camera raw parameters back to the state they were at when you first selected the current clip.

### Updating Sidecar Settings for Blackmagic RAW (BRAW) Clips

Blackmagic RAW clips support both embedded look metadata within the .braw media clip and external look metadata in .sidecar files. Ordinarily, these files travel in pairs whenever you manage BRAW media, and whenever a .sidecar file is present, its settings override those of the embedded metadata within the actual .braw clip. Since the .sidecar metadata is in human-readable JSON formatted text, it’s easy to edit and accommodates a wide variety of onset to post-production workflows.

The .braw and .sidecar files as seen in the file system

If you like, you can make changes to the raw look metadata of a .braw clip and upgrade the .sidecar metadata from within the Color page of DaVinci Resolve, so the media on disk reflects these changes in any other BRAW compatible application.
To update the .sidecar raw look metadata:

1. Open the Color page, select a .braw clip in the Thumbnail timeline, and open the Camera Raw palette.
2. Set Decode Using to Clip to enable the palette controls.
3. Make whatever adjustments you want to make using the controls of the Camera Raw palette.
4. When you’re done, click the Update Sidecar button.
Chapter 129

Primaries Palette

This chapter focuses on the core color adjustments that you’ll be making to create “primary” corrections that alter the overall color and contrast of the image using both the Lift/Gamma/Gain adjustments in the Wheels and Bars modes of the Primaries palette, and the Shadow/Midtone/Highlight/Offset controls in the Log mode, both of which have traditionally formed the foundation of most grades.

Contents

Introduction to the Primaries Palette 2583
HDR Grading With the Primaries Palette 2584
Which Do I Start With, the Primaries or HDR Palette? 2584
Shared Controls in the Primaries Palette 2584
Color Balance Controls 2584
Master Wheels 2585
Numeric Parameters 2585
Shared Adjustment Controls 2586
Auto Correction 2587
Reset Controls 2588
Wheels and Bars 2588
3-Way Master Wheel Adjustments 2589
Offset Color and Master Controls 2590
Bars Mode 2590
Log Mode 2591
Using the Log Mode Controls to Grade Log-Encoded Media 2592
Using the Log Mode Controls to Stylize Normalized Media 2594
Adjusting the Default Tone Ranges in Log Mode 2595
Adjusting Contrast in Log Mode 2595
Log Offset Color and Master Controls 2595
Introduction to the Primaries Palette

If you’ve had any exposure to color correction tools in any application, the Lift/Gamma/Gain controls found within the Wheels mode of the Primaries palette should look familiar. These controls correspond to the most traditional and basic color correction functionality available in DaVinci Resolve and are designed to let users without control panels have easy access to color balance and YRGB contrast manipulation using a mouse, tablet, or trackpad.

As the name implies, the Primaries palette has been designed for the kind of overall “primary” color adjustments to the image that typically serve as the foundation of any grade. "Secondary" adjustments then refer to more specific adjustments made to isolated subjects within the image. However, it's a time-tested practice that you do everything you can to get the overall image right using one or more primary corrections before moving on to more specific detail work built on top of these initial adjustments. For one thing, it's a more structured, organized way to work. However, it’s also the most efficient way to make sure you're tackling the image in a holistic way, that maximizes improvements while minimizing stress on the video signal.

The Primaries palette has three distinct modes of operation:

- Wheels mode contains the traditional DaVinci YRGB Lift/Gamma/Gain controls that allow tonally specific yet widely overlapping regions of adjustment. Wheels mode also provides access to the RGB Offset/Printer Points color balance and master controls.

- Bars mode gives access to the same YRGB Lift/Gamma/Gain and Offset controls as the Primaries Wheels mode, but the Bars interface lets you make vertical slider-driven adjustments to individual YRGB lift, YRGB gamma, and YRGB gain channels, as well as providing a slider and button-driven interface for the RGB Offset/Printer Points controls.

- Log mode is the home of the RGB Offset/Printer Points color balance and master controls that adjust the overall signal in a linear, film-oriented way. Log mode provides Shadow/Midtone/Highlight/Offset controls that offer more restrictive yet customizable regions of adjustment intended for making adjustments to log-encoded image data.

Which mode you use depends entirely on how you like to work, and what kinds of adjustments you need to make.
HDR Grading With the Primaries Palette

Starting in DaVinci Resolve 17, some of the palettes of the Color page with which color adjustments are made have been made “color space aware.” This means that the functionality of the palette will be mostly the same no matter what Timeline Color Space you’re using, or whether you’re grading to create SDR or HDR output. However, not every color palette has been made color space aware, and so when using various grading controls in the Color page to grade wide-latitude images for HDR output, if you find the controls aren’t working smoothly, you may find it useful to enable the HDR Mode of the node you’re working on by right-clicking that node in the Node Editor and choosing HDR Mode from the contextual menu (this is only available in Resolve Studio).

This setting forcibly adapts that node’s controls to work within an expanded HDR range. Practically speaking, this makes it easier to work with wide-latitude signals using controls that operate by letting you make adjustments at different tonal ranges such as Lift/Gamma/Gain or the Log controls.

Which Do I Start With, the Primaries or HDR Palette?

The HDR palette, introduced in DaVinci Resolve 17, has also been developed to work as a powerful method of creating primary adjustments to serve as the foundation of your grade. While the Global and Zones controls of the HDR palette operate from a different philosophy of signal adjustment, they’re designed to let you tackle the same issues, so it’s a completely valid choice to start out using the HDR palette instead of the Primaries palette. So, which to use?

Ultimately, this is going to come down to your comfort with the HDR palette, and your experience with the Primaries palette. If your muscle memory of working with the Primaries palette continues to make it the fastest way for you to dial in your adjustments, there’s no reason to stop using it now. In fact, the Offset/Printer Points controls in the HDR palette continue to be adjustments that are distinctly different from the functionality found within the HDR palette.

However, you should also give the HDR palette a try, because it has powerful primary grading capabilities that aren’t possible with the Primaries palette modes. Even if the functionality is new to you, if you give it a week you’ll find innumerable advantages to the HDR palette’s way of doing things, even though it requires some new ways of looking at the process.

The bottom line, however, is that you’ll probably continue using both palettes. If you do, keep in mind that in each Corrector node’s order of image processing operations, the HDR palette controls are processed before the Primaries palette controls, largely because the HDR palette’s more “photographic” approach to grading has been intentionally designed to meet the needs of primary color adjustment in our new world of wide-gamut HDR mastering and output, so it’s been fit into the image processing pipeline as the new foundation of all adjustments.

Shared Controls in the Primaries Palette

This section explains, in a generic way, how to use the common control interface conventions used by the Wheels, Bars, and Log modes to make adjustments. It also describes the use of parameters that are shared among all three modes.

Color Balance Controls

Whether you’re using the Wheels or Log controls, Color Balance controls provide a way to adjust all three color channels of a particular range of the image simultaneously with a single move of the pointer, according to the mode that’s currently selected. There are also a variety of keyboard modifiers that let you make specific adjustments via the GUI. These controls also correspond to the trackballs found on any of the DaVinci or third-party control panels, should you have one connected.
Methods of making adjustments using the Color Balance controls:

- **Click and drag anywhere within the color ring:** Moves the Color Balance indicator relative to its previous position, and rebalances the three color channels in whatever range of image tonality is governed by that control. You don’t need to drag the Color Balance indicator itself. This simulates the kind of relative control you get when using a trackball to manipulate these parameters. As the Color Balance indicator moves, the RGB parameters underneath change independently to reflect the independent adjustments being made to each channel.

- **Shift-click and drag within the color ring:** Jumps the Color Balance indicator to the absolute position of the pointer, letting you make faster, more extreme adjustments to the color balance governed by that control.

- **Double-click within the color ring:** Resets the color adjustment without resetting the corresponding contrast adjustment for that control.

- **Command-click and drag within the color ring:** Adjusts YRGB contrast identically as if you were dragging that control’s master ring.

- **Click the reset control at the upper-right of a color ring:** Resets both the Color Balance control and its corresponding master ring.

**Master Wheels**

The Master Wheels, located below the Color Balance controls, let you adjust the YRGB channels for a particular range of image tonality together. This has the practical effect of letting you adjust image lightness and contrast.

![Master Wheels](image)

The Master Wheels correspond to the rings surrounding the trackballs on all of the DaVinci control panels, which let you modify image contrast via YRGB adjustment (as opposed to modifying image contrast via Y-only adjustment, discussed later in this chapter).

**To adjust a Master Wheel:**

- Dragging a Master Wheel to the left makes the corresponding tonal region of the image darker, and dragging it to the right makes that tonal region of the image lighter. The effect will vary according to the mode you’re in. As you make an adjustment, the YRGB parameters located underneath all change together to reflect the simultaneous adjustment you’re making to all channels.

**Numeric Parameters**

Each Color Balance Control and Master Wheel pair of controls also have a set of four YRGB number fields underneath that display the YRGB adjustment being made by both controls. These four values encompass every color and master adjustment you can make with these controls, and they also directly correspond to the Bars interface that mirrors the Wheels controls.

These fields can be edited like any other parameter on the Color page. Even though these values display two decimal places of precision because of space restrictions in the interface, they really contain three decimal places of precision since these are floating point operations; you just can’t see the third decimal place.
To edit YRGB values directly:

- You can double-click on a field to edit its value numerically.
- You can insert the text cursor next to a value in this field, and use the Up and Down Arrow keys to adjust the value one digit at a time.
- You can cut, copy, and paste values among fields.
- You can click on the field and drag left or right to adjust its value with a virtual slider.

The number fields for each Color Balance Control and Master Wheel are editable.

Shared Adjustment Controls

The three modes of the Primaries palette also share two strips of controls for making more specific adjustments to different aspects of the image, such as Contrast, Saturation, Hue, Highlight retrieval, Color boost, and so on.

Like most parameters in DaVinci Resolve, clicking and dragging a parameter’s name or value to the left or right lowers and raises that parameter with a virtual slider, while double-clicking that parameter’s number lets you edit it numerically, and double-clicking that parameter’s name resets the parameter to its default position.

The top adjustment controls

- **Temp**: A specifically constrained Gain color balance adjustment that lets you adjust the image along a warm/orange to cool/blue axis corresponding to the naturalistic spectrum of color temperatures used for lighting. Raising this parameter performs a Gain color balance adjustment toward orange, while lowering this parameter to a negative value performs a Gain color balance adjustment toward a blue/cyan split. 0 is unity. The range is –4000 to +4000.

- **Tint**: A specifically constrained Gain color balance adjustment that lets you adjust the image along a magenta to green axis corresponding to the unnatural spectrum of color temperatures found in artificial lighting sources such as fluorescent and sodium vapor lighting fixtures. Raising this parameter performs a Gain color balance adjustment toward magenta (sometimes referred to as “minus green” to correct for fluorescent lighting), while lowering this parameter to a negative value performs a Gain color balance adjustment toward green (“plus green” to correct for other kinds of lighting). 0 is unity. The range is –100 to +100.

- **Contrast**: The Contrast parameters let you quickly narrow or widen image contrast about a user-definable pivot point. Regardless of which mode you’re in, these parameters are identical. Contrast and pivot can also be adjusted using the DaVinci control panel via the CONTRAST and PIVOT knobs on the Center panel’s default page, regardless of whether you’re in Lift/Gamma/Gain or Log mode.

This one parameter lets you increase or reduce the distance between the darkest and lightest values of an image, raising or lowering image contrast. The effect is similar to using the Lift and Gain master controls to make simultaneous opposing adjustments. Bright and dark parts of the image are pushed apart or brought together about a center point defined by the Pivot parameter. The “Use S-curve for contrast” setting in the General Options panel of the Project Settings (on by
default) sets the contrast control to apply an “S-curve” to the image, such that the shadows and highlights of a signal will not be clipped when you increase the value. If you would prefer for these contrast adjustments to be made linearly, and for the signal to be allowed to clip when you reach the upper and lower boundaries of the video signal, you can turn this checkbox off.

– **Pivot:** Changes the center of tonality about which dark and bright parts of the image are stretched or narrowed during a contrast adjustment. Darker images may require a lower Pivot value to avoid crushing the shadows too much when stretching image contrast, while lighter images may benefit from a higher Pivot value to increase shadow density adequately.

– **Midtone Detail (MD):** When this parameter is raised, the contrast of regions of the image with high edge detail is raised to increase the perception of image sharpness, sometimes referred to as definition. When this parameter is lowered to a negative value, regions of the image with low amounts of detail are softened while areas of high-detail are left alone. 0 is unity. The range is –100 through +100.

The bottom adjustment controls

– **Color Boost:** A non-uniform saturation operation that affects regions of low saturation more than regions of high saturation. This is sometimes referred to as a vibrance operation. 0 is unity, showing the original color values. Raising color boost from 0-100 increases color intensity, but low-saturation parts of the image are raised more aggressively. Lowering color boost from 0 to -100 decreases color intensity, but low-saturation parts of the image are lowered more aggressively. 0 is unity, showing unaltered saturation. The range is –100 through +100.

– **Shadows:** Lets you selectively lighten or darken shadow detail. Raising this value retrieves shadow detail recorded below 0 percent, while leaving the midtones alone. 0 is unity. The range is –100 through +100.

– **Highlights:** Makes it easy to selectively retrieve blown-out highlight detail in high-dynamic-range media by lowering this parameter, and achieves a smooth blend between the retrieved highlights and the unadjusted midtones for a naturalistic result. 0 is unity. The range is –100 through +100.

– **Saturation:** A uniform saturation operation that raises (above 50) or lowers (below 50) the color intensity of every color value within the image. 50 is unity, showing unaltered saturation. The range is 0 (completely desaturated) through +100 (saturation is doubled).

– **Hue:** Rotates all hues of the image around the full perimeter of the color wheel. The default setting of 50 shows the original distribution of hues. Raising or lowering this value rotates all hues forward or backward along the hue distribution as seen on a color wheel.

– **Lum Mix:** Lets you control the balance between YRGB contrast adjustments you’ve made using the Master Wheels or ganged Custom curves, and Y-only adjustments to contrast made using the Y channel Lift/Gamma/Gain controls of the Primaries palette or the unganged Luma curve. At the default of 100, YRGB and Y-only adjustments to contrast contribute equally. Reducing this value diminishes the effect of Y-only contrast adjustments until, at 0, Y-only contrast adjustments are turned off. Additionally, you’ll notice that at the default Lum Mix setting of 100, individual adjustments to R, G, or B using the RGB sliders or unganged Custom curves result in automatic adjustments being made to the other two color channels in order to maintain constant Luma levels. At a Lum Mix setting of 0, individual color channel adjustments have no effect on the other color channels.

**Auto Correction**

The Auto Color command provides a quick way to automatically balance the blacks and whites of a clip based on the current frame at the position of the playhead. As of DaVinci Resolve 16, the A button in the Primaries palette and the Shot Match command that is available from the Thumbnail Timeline.
contextual menu both now use advanced algorithms, based on the DaVinci Neural Engine, to provide superior results when automatically adjusting color balance and contrast. These controls have been developed to provide optimal results when working in the Rec. 709 color space, and at a gamma of 2.4, so they work well in conjunction with using Resolve Color Management (RCM) to normalize media first.

For more information on using these, see Chapter 127, “Automated Grading Commands and Imported Grades.”

**Reset Controls**

The Reset control, found at the upper right-hand corner of the Primaries palette, lets you reset every single setting in the entire palette. However, there are a variety of parameter-specific reset controls available to make more targeted resets.

- Each pair of Color Balance and Master Wheel controls have a reset control that resets both.
- Each numeric parameter can be individually reset by double-clicking the name of the parameter.
- The numeric parameters underneath each Color Balance and Master Wheel control pair can be reset by double-clicking the color label that appears underneath them.

**Wheels and Bars**

The Color Wheel palette’s Primaries Wheels mode lets you rebalance color and adjust contrast via the traditional DaVinci controls, which govern three overlapping tonal ranges referred to as Lift, Gamma, and Gain. The Lift/Gamma/Gain color balance and Master Wheel controls are tied to the YRGB Lift/Gamma/Gain sliders found in the Primaries palette; adjustments made to one set of controls are mirrored in the other.
These tonal ranges are defined by image lightness, on a scale where 0 is absolute black and 1023 is absolute white. The following illustration shows an approximation of how the Lift, Gamma, and Gain tonal zones broadly overlap, and how each zone’s influence falls off towards the opposing extremes of image tonality.

![Graphic displays the relationship of the Lift, Gamma, and Gain controls over the image brightness range that they control](image)

The Lift color balance control region of influence starts at black, and then falls off through the middle grays to diminish to no influence at white. Meanwhile, the Gamma color balance control has its greatest influence over the image in the middle grays, and its influence diminishes towards black and white. Lastly, the Gain control is the inverse of Lift, having its greatest effect on the image at white, with its influence falling off to diminish at black.

Because these tonal ranges overlap so broadly, you can make very soft, subtle, naturalistic adjustments using these controls. Furthermore, you can capitalize on their overlap by moving an adjacent color balance control toward a color that’s complementary to an adjustment you’ve just made to restrict further how much of the image is affected.

The following image shows the interaction of extreme corrections made to a grayscale image using all three Color Balance controls. Lift has been pushed toward green, Gamma has been pushed toward blue, and Gain has been pushed toward red.

![Extreme adjustments showing the overlap of the Lift, Gamma, and Gain color balance controls](image)

Notice how, even though these corrections are extreme, the colors blend smoothly. This is the reason for the broad overlap among all three controls, and why Lift, Gamma, and Gain are so effective in making corrections to the ambient color temperature of a scene to account for inconsistencies in lighting or camera settings.

**3-Way Master Wheel Adjustments**

The Master Wheels located below the Color Balance controls let you precisely modify image contrast by YRGB adjustments, which individually alter the black point, the white point, and distribution of midtones that fall in-between.

These controls correspond to the rings surrounding the trackballs on the DaVinci control panel.

- **Lift**: Lets you adjust the perceived shadow density of the image by altering the black point of the image. Dragging the Lift master wheel to the left makes the darkest values in the image darker, increasing the distance between the black and white points of the image, and stretching all the midtone values in-between. Dragging the Lift master wheel to the right makes the darkest values in the image lighter, reducing contrast and squeezing all the midtone values between the black and white points.
– **Gamma:** Lets you adjust the overall perceived lightness of the image by altering the distribution of midtones that fall between the Lift and Gain master wheel settings. Dragging the Gamma master wheel to the left darkens the overall image, while dragging it to the right brightens it. Most Gamma contrast adjustments have a minimal effect on the black and white point of the image, but large adjustments may push either boundary of image lightness farther out. This interaction is described in more detail below.

– **Gain:** Lets you adjust the lightness of the highlights by altering the white point of the image. Dragging the Gain master wheel to the left makes the lightest values of the image darker, squeezing the midtones between the white and black points of the image. Dragging Gain to the right makes the lightest values even lighter, eventually clipping at maximum white.

Waveform display shows the clips contrast range

These contrast adjustments are not limited by one another. For example, raising or lowering the Gamma master wheel by a large amount may push the highlights of the image higher or the shadows of the image lower, regardless of the current Lift or Gain contrast setting.

As a result, these controls are somewhat interactive, and you may find yourself going back and forth between controls as you make your final contrast adjustments. This is one of the reasons a control panel is valuable, as it allows you to adjust all three settings simultaneously.

### Offset Color and Master Controls

The fourth set of Color Balance and Master Wheel controls is actually shared with the Log controls and with the Offset sliders in the Primaries palette. These are the Offset controls, which let you make linear adjustments to rebalance the entire tonal range of the RGB channels. There is no Y-only control for Offset, only a Master RGB adjustment.

– **The Offset color balance control:** Works as a simultaneous adjustment to all three Offset sliders located in the Primaries palette; adjustments made to the Offset color balance control also alter the Offset sliders. Used subtly, this makes it easy to neutralize color imbalances in the darkest part of the image, while simultaneously rebalancing every other part of the image. Used more dramatically, this control makes it easy to add a color wash throughout the entire image.

– **The Offset master wheel:** Acts as a global adjustment to image lightness, an operation sometimes referred to as setup, raising or lowering all RGB channels together.

When using a DaVinci Micro or Mini control panel, the Offset color balance and master controls are adjusted via either the third trackball and ring while in Offset mode, or the fourth trackball and ring of the DaVinci Advanced Panel in Offset mode.

### Bars Mode

The Bars mode contains the original set of DaVinci Resolve color adjustment sliders. These sliders serve two uses. First, they’re highly visible indicators of the individual YRGB channel adjustments that
are made using the trackballs, rings, and knobs of a grading control panel. Second, they provide control of individual YRGB Lift/Gamma/Gain parameters using a mouse, tablet, or trackpad.

The main controls of the Bars mode are the individual Luma (or Y), Red, Green, and Blue sliders, four each for Lift, Gamma, and Gain. These sliders provide precise Lift/Gamma/Gain style control over each of the YRGB channels of the image. When used in conjunction with a Parade Scope video analysis of the image, these controls can enable you to fix irregular color imbalances in specific channels quickly.

Additionally, the Luma (Y) Lift/Gamma/Gain sliders allow easy Y-only adjustments to contrast, where an increase in contrast results in perceptually diminished color saturation. These correspond to the three knobs arranged vertically to the left of the Trackball panel of the DaVinci Advanced control panel, or the three left-most knobs of the DaVinci Micro or Mini control panels.

Making Y-only adjustments to contrast is a great way to increase contrast when you’re going for muted saturation or a gritty look. This kind of adjustment is also useful in situations where you’re trying to increase shadow density without increasing image colorfulness.

Log Mode

The Shadow/Midtone/Highlight color balance and Master Wheel controls operate independently of the Lift/Gamma/Gain color balance and Master Wheel controls found in the Primaries mode. While the Log mode uses the same types of controls as the Primaries mode, the way each control affects the image is very different.

To switch between the Primaries and Log modes of the Wheels:

– Choose an option from the mode drop-down, click the right mode button, or press Option-Z.
There are two ways of using the Log mode controls. The first takes advantage of the way these controls work to make fast, filmic adjustments to log-encoded media prior to it being normalized or “de-logged” by operations that are performed using nodes appearing after it in the image processing pipeline of your node tree. Normalizing or de-logging the image can be done via Color Space Transform operations, LUTs, and manual adjustments if you’re grading using DaVinci YRGB color science. If you’re using color management, they can be done via the Output Color Space setting of Resolve Color Management (RCM), or via the ACES Output Device Transform (ODT).

The other way of using the Log controls is to take advantage of the more restrictive, but adjustable tonal range of the Shadow/Midtone/Highlight controls to stylize normalized clips by tinting or adjusting the contrast of tonally-specific regions of the image.

**Whether or Not to Use Legacy Log Grading Ranges and Curve**

DaVinci Resolve 12.5 introduced a modification to the Log grading controls that provides smoother, more pleasing results using the same controls. To maintain backward compatibility with older projects, a “Use legacy Log grading ranges and curve” checkbox in the General Options panel of the Project Settings lets you switch your project between the older Log control behavior and the newer one. Older projects that are opened in DaVinci Resolve have this checkbox turned on by default, while new projects have this turned off by default.

**Using the Log Mode Controls to Grade Log-Encoded Media**

The Log controls are so named because they’re designed to work specifically with media with Log-C or similar gamma and color encoding, derived from the Cineon Log gamma curve, developed by Kodak to digitally store flat-contrast, wide-gamut image data that preserves image detail with a wide latitude for adjustment.

You can debayer most raw formats to a log-encoded image in order to derive the maximum amount of image data and adjustable latitude from that source (for more information, see Chapter 6, “Camera Raw Settings”). However, the resulting image needs to be normalized to occupy the final range of color and contrast that you intend for the final result. You can do this one of two ways:

- You can make a very careful curves adjustment in a second node to stretch the log-encoded image out to fit the contrast profile you want. By making this adjustment in Node 2, you make room for a customizing adjustment made using the Log controls in Node 1, prior to the normalization adjustment. This is key.

- You can also apply a 1D Output or 3D LUT to the first node of a clip to normalize the image. This is a faster, if less flexible operation, but a smooth tonal range may be easier to obtain. Since a LUT applied within a node is always the last adjustment within that node’s order of operations, you can also use Node 1’s Log controls to customize the look of the footage.
In either case, it’s important that the normalizing adjustment happens after your Log control adjustments, for the Log control adjustments to work as they should. With your node tree set up in this way, you’ll be monitoring an ordinary-looking image, but taking advantage of the Log mode controls’ unique tonal ranges to manipulate the log-encoded image data with great specificity.

**TIP:** Within corrector nodes, LUTs are applied after Log control adjustments, so if you want to keep the number of nodes in your node tree to a minimum, you can apply a normalizing (or de-log) LUT to the same node with which you’re making Log adjustments, knowing that the LUT will be properly applied after log adjustments. For more information, see Chapter 141, “Image Processing Order of Operations.”

**When using the Log mode controls, here’s a workflow to consider as you learn how they work:**

- First, use the Offset master wheel to set the black point, and use the Contrast and Pivot parameters to stretch or compress contrast as necessary to achieve the tonal range you require.
- Second, use the Offset color balance control to adjust the overall color balance of the image to your liking.
- Third, use the Shadow/Midtone/Highlight color balance and Master Wheel controls to make specific, targeted adjustments to the color and contrast of the image in tonal ranges that match where that data is in the log-encoded image.

Working in this way, you’ll find that adjustments made with the Offset color balance and Master Wheel controls and Contrast controls control the log-encoded image very nicely to create an overall adjustment, while the Shadow, Midtone, and Highlight controls allow you to fix specific issues, such as shadow balance and density, after your main adjustment has been set.

The following illustration shows an approximation of how the default ranges of the Shadow, Midtone, and Highlight controls divide the tonal range of a log-encoded image.

As you can see, when used with a log-encoded image the color interactions between each adjustment overlap very softly, while still allowing more specific adjustments than those made by the Lift/Gamma/Gain controls.

Furthermore, the boundaries of the Shadows, Midtones, and Highlights Log controls can be customized using the Low and High Range parameters. This gives you added flexibility to apply more specific contrast and color adjustments.

Once you’ve made an adjustment using Log mode controls along with a normalizing LUT or curve adjustment, you can always apply additional nodes and use the Wheels mode of the Primaries palette to make further alterations to the now normalized image, working as you normally would with any of the other tools in DaVinci Resolve.
TIP: Internal to each node’s image processing order of operations, the Lift/Gamma/Gain adjustments of the Wheels mode are applied prior to the Shadow/Midtone/Highlight/Offset adjustments of the Log mode, so if you want to apply Log mode controls before Wheels mode controls, then you need to use Wheels controls in a subsequently added node. For more information, see Chapter 141, “Image Processing Order of Operations.”

Using the Log Mode Controls to Stylize Normalized Media

You can also use the Log mode controls on already normalized images. Although the results you get will be somewhat different, this can be a fast way to create interesting stylizations. Whereas the broadly overlapping tonal ranges of the Lift, Gamma, and Gain color balance controls allow subtle adjustments to be made very easily, the Log palette’s color balance controls affect much more restrictive tonal zones that overlap much less when used on normalized images.

The following illustration shows an approximation of how the Shadows, Midtones, and Highlights, by default, divide the tonal range of the image into non-overlapping thirds. As you saw in the previous section, these divisions were originally intended to map to log-encoded media. However, with normalized media these divisions provide a different, and potentially useful, set of ranges from the Primaries mode controls.

With normalized media, the Shadows really do only affect the darkest shadows, falling off at approximately the bottom third of image tonality. The Midtones affect only the middle third of grays, and the Highlights affect the brightest top third of image values. However, these default ranges of image tonality can be adjusted using the Low Range and High Range controls, which are described in more detail later.

The following image shows the default interaction of extreme corrections made to a grayscale image using the Log mode controls. The Shadows have been pushed toward green, the Midtones have been pushed toward blue, and the Highlights have been pushed toward red.

As you can see, with normalized media the color interaction between each adjustment is very subtle. The darkest shadows end up bright green, the midtone values are vivid blue, and the highlights are almost pure red. This restrictiveness is useful when you want to limit a correction to a specific tonal...
range within the image without needing to use a Luma qualifier. It’s also quite useful for making bold, stylistic color adjustments when creating a non-naturalistic look.

TIP: The Highlights adjustment of the Log controls can also be extremely useful for boosting or otherwise controlling the highlights of HDR grades. However, the multiple highlight zones of the HDR palette afford a much higher degree of control over this kind of adjustment, using similar control panel-friendly controls.

Adjusting the Default Tone Ranges in Log Mode

When in Log mode, two additional parameters appear in the top shared controls bar that let you modify the range of Shadows and Highlights image tonality that each Color Balance control affects, in turn narrowing and widening the range of Midtones. Keep in mind that while the ranges can be customized, the amount of overlap between each range cannot.

– **Low Range:** Moves the border where the Shadows and Midtones meet. Lowering this parameter widens the range affected by the Midtones, and narrows the range affected by the Shadows. Raising this parameter narrows the Midtones and widens the Shadows.

– **High Range:** Moves the border where the Midtones and Highlights meet. Lowering the High Range parameter narrows the range affected by the Midtones, and widens the range affected by the Highlights. Raising this parameter narrows the Highlights and widens the Midtones.

There are also Saturation and Hue parameters which mimic these settings found within other palettes and modes.

Adjusting Contrast in Log Mode

When using the Log mode controls, your primary tools for adjusting image contrast will usually be the Offset master wheel and Contrast and Pivot parameters. Using these three controls, you can set a black point and adjust the overall contrast very quickly.

The Shadow, Midtone, and Highlight master wheels let you adjust image lightness within the same restrictive ranges of image tonality that are defined by the Low Range, High Range, and Pivot parameters. These adjustments should appear smooth, if somewhat narrower then the Lift/Gamma/Gain controls, when used with log-encoded media. However, when used with normalized images, severe adjustments made with one master wheel may not always make a smooth transition to the next adjacent range of image lightness.

NOTE: Because these controls are so restrictive when used with normalized images, it’s easy to create solarization effects by raising the shadows to be higher than the Midtones, or lowering the Highlights to fall below the Midtones, to give two examples.

Log Offset Color and Master Controls

The Log controls share the same Offset color balance and Master Wheel controls that appear in the Lift/Gamma/Gain mode of the Wheels and Bars controls. The Offset controls are in fact processed as part of the Log controls, but for convenience they’re presented with the Wheels controls because they’re so useful.
The Offset color balance control: Works as a simultaneous adjustment to all three Offset sliders located in the Primaries palette; adjustments made to the Offset color balance control also alter the Offset sliders. Used subtly, this makes it easy to neutralize color imbalances in the darkest part of the image, while simultaneously rebalancing every other part of the image. Used more dramatically, this control makes it easy to add a color wash throughout the entire image.

The Offset wheel: Acts as a global adjustment to image lightness, an operation sometimes referred to as setup, raising or lowering all YRGB channels together.

Offset and Printer Points

In Bars mode, the Offset controls are represented by three vertical sliders, which mirror the settings of the Offset color balance controls in the Color Wheel palette, except that they provide individual control over the Red, Green, and Blue color channels. In fact, this interface also happens to be the epicenter of the Printer Points functionality offered by DaVinci Resolve.

When you drag one of the Offset sliders up or down, you raise or lower that color channel in its entirety. This can be useful for adjusting color channels that are particularly problematic, but it’s also the way you impose the kinds of traditional linear color adjustments that color timers of film have employed for decades. In fact, many colorists consider the simplicity of these controls a virtue, and embrace the slight shadow or highlight contamination that can result from color balancing in this linear way as a creative hallmark of traditional cinema color adjustment.

Offset and Printer Points

NOTE: Unlike the other Color Balance control adjustments described in this chapter, the Offset controls do not use the Lum Mix parameter to control whether individual adjustments to the R, G, or B channels result in automatic adjustments being made to the other two color channels in order to maintain constant Luma levels. All Offset and printer points adjustments made to a specific color channel affect only that color channel.

Adjusting Printer Points in the Bars Mode

Each Offset slider also has a pair of arrow buttons, one at the top and one at the bottom. These buttons provide “Printer Point” adjustment of these values, which let you adjust each Offset channel in discrete increments. Printer Points can be useful for projects that have tight integration with a film lab, and are designed to emulate color adjustments made using optical printers.
The "plus" and "minus" red, green, and blue buttons for making printer point adjustments.

The Offset wheel control underneath the Offset sliders lets you adjust all three sliders at once, performing a master or setup adjustment. The Offset sliders, Printer Point buttons, and Offset wheel can be adjusted using keyboard shortcuts, or using the DaVinci control panel.

**NOTE:** The DaVinci Resolve Advanced and Mini color grading panels each have support for adjusting printer points using rotary controls for the Red, Green, and Blue channels, as well as All channels together.

---

**Adjusting Printer Points Via Keyboard Shortcuts**

One of the best ways of using printer points if you don’t have a color control panel that supports them is to enable the numeric keypad to use dedicated keyboard shortcuts just for printer points.

**To use the Printer Lights Hotkeys:**

– Choose Color > Printer Lights Hotkeys, or press Option-Command-Grave Accent (’)

When you enable Printer Lights Hotkeys, there are two sets of shortcuts you can use to manipulate printer points. First, if you want to directly manipulate RGB in whole increments, there’s one set for that.

<table>
<thead>
<tr>
<th>Red</th>
<th>Green</th>
<th>Blue</th>
</tr>
</thead>
<tbody>
<tr>
<td>7 - Plus Red</td>
<td>8 - Plus Green</td>
<td>9 - Plus Blue</td>
</tr>
<tr>
<td>4 - Minus Red</td>
<td>5 - Minus Green</td>
<td>6 - Minus Blue</td>
</tr>
</tbody>
</table>

However, if you want to work in the classic way by manipulating cyan, magenta, and yellow in whole increments, there’s another set of shortcuts for that, using the remaining keys on the numeric keypad.

<table>
<thead>
<tr>
<th>Cyan</th>
<th>Magenta</th>
<th>Yellow</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Plus Cyan</td>
<td>2 - Plus Magenta</td>
<td>3 - Plus Yellow</td>
</tr>
<tr>
<td>Minus (–) - Minus Cyan</td>
<td>0 - Minus Magenta</td>
<td>Period (.) - Minus Yellow</td>
</tr>
</tbody>
</table>

There are also a pair of keyboard modifiers that gives you finer control over printer points adjustments made with these special keyboard shortcuts, while retaining the coarser default adjustments that let you make bigger changes more quickly:

– Hold down Command while using these key shortcuts to adjust printer points in quarter-increments.

– You can use half-increments as well, but you will need to assign the keyboard shortcuts for these manually.
Printer Light Step Project Settings

The increments used by the Printer Point buttons are defined by the Printer Light Step Calibration parameters, found in the Color panel of the User Preferences. The default settings are designed to emulate traditional film printer adjustments, but these settings can be customized to align DaVinci Resolve’s printer points adjustments with those of a particular film lab’s equipment. However, if you’re not working with a lab, you can change the Step and Density settings to alter how much of an adjustment each printer point makes according to your own preferences. For more information, see Chapter 4, “System and User Preferences.”

### Tip
If you’re feeling left out because all the cool kids are using printer points and you’re unfamiliar with them, making the Parade scope visible is a great way to learn how these adjustments work while seeing their specific effects on the red, green, and blue channels of the video signal.
Chapter 130

HDR Palette

This chapter focuses on the global and zone-based adjustments found in the HDR palette, which is DaVinci’s newest primary grading tool. Despite its name, this palette can be used, as you might the Lift/Gamma/Gain mode of the Primaries palette, to create the foundational adjustment for any SDR or HDR grade. However, its zone-based nature gives it the power and specificity of curve-based adjustments, making the HDR palette suitable for a multitude of creative and corrective tasks. Furthermore, this palette’s color space awareness, as well as the perceptually uniform color space in which its adjustments are made, make this palette uniquely suited for controlling the saturation and highlights of HDR mastered images.

Contents

Introduction to the HDR Palette 2600
What Makes the HDR Palette Special? 2601
The HDR Palette Interface 2603
Navigating Multiple Zones in the Controls Panel 2603
Making Global Adjustments 2604
Black Offset Explained 2608
Making Zone-Based Adjustments 2610
Zone-Based Color Adjustments 2610
Zone-Based Exposure Adjustments 2613
An Example of Zone-Based Exposure Adjustment 2614
Zone Controls 2616
Customizing Zones Using the Zone Panel 2617
The Zone Sidebar 2618
Zones Graph 2619
Customizing and Saving Presets 2620
Resetting Color and Zone Adjustments 2620
Using the HDR Palette With DaVinci Control Panels 2621
Introduction to the HDR Palette

The HDR palette is specifically designed to enable fast and flexible primary grading of wide-latitude media for either SDR or HDR output. It’s “color space aware” in that it works with Resolve Color Management to fit the known mapping of source image data within the HDR palette’s own perceptually uniform operational color space. Using advanced color processing algorithms, this enables more efficient color and contrast adjustments, and perceptually uniform controls that make it easier to adjust all colors equally across the spectrum, while maintaining careful control of image saturation.

A set of global controls, at the right of the palette, let you make foundational adjustments to the overall image, along with a set of Hue, Midtone Detail, Contrast/Pivot, and Black Offset controls at the bottom. Additionally, a set of overlapping zone-specific controls let you make color and contrast adjustments to specific ranges of image tonality. Altogether, the HDR palette lets you make primary grading adjustments that are both photographically naturalistic and as tonally broad or specific as you require, while minimizing unwanted artifacts.

Despite its sophistication, the HDR palette uses color balance and slider controls that should be familiar to any colorist or editor familiar with the more conventional Lift/Gamma/Gain controls. Whether you’re a grading professional or just getting started with color, the HDR palette will enable great results with less hassle once you learn how to harness its power.

TIP: Due to the increasing ubiquity of HDR-capable media and HDR streaming distribution workflows, the node HDR mode and HDR palette are both available without restriction in the free downloadable version of DaVinci Resolve.
What Makes the HDR Palette Special?

Before diving into the detailed use of the HDR palette’s controls, it’s important to understand a bit more about how the HDR palette processes image data, so you can better understand what advantages this tool presents.

Using the HDR Palette Without Color Management

While the HDR palette has been designed to work hand in hand with color management, you can use it in non-color managed workflows so long as you set it up correctly. The HDR palette option menu has Color Space and Gamma submenus that let you specify how you want to work. By default, both submenus are set to “Timeline” to reflect the color space you’re choosing to work within in display-referred workflows.

Color Space Aware Controls When Using Color Management

The HDR palette really shines when you enable Resolve Color Management or ACES, because it’s a color space aware palette that uses color management to full advantage. Being color space aware means that the color and contrast controls of the HDR palette conform themselves to the range of each clip’s image data as mapped from the Input Color Space assigned to the source clip to the Timeline Color Space your program is working within. Practically, this provides two benefits:

– The controls of the HDR palette work and feel virtually identical no matter what type of source clip you’re adjusting, and no matter which timeline color space you’re choosing to work within.

– HDR palette adjustments made to one type of media will have a similar result when copied to other types of media. This makes making matching shots and copying looks from one type of media to another easier than with previous tools.

NOTE: Because the HDR palette is color space aware, it’s not necessary to enable the HDR setting on nodes for controls to work intuitively while working within a wide gamut Timeline Color Space, or delivering to an HDR format like ST.2084. The HDR palette takes care of this for you, automatically.

Perceptually Uniform Adjustments

Furthermore, the image data of each clip is converted from the Timeline Color Space to an operational color space used by the HDR palette, where the image is adjusted and then converted back to the Timeline Color Space again, ready for the next operation. The operational color space that’s used by the HDR palette is perceptually uniform, which means that the range of values corresponding to each visible hue are distributed evenly throughout this color space.

While the HDR palette works well grading standard dynamic range (SDR) material, the underlying color science used by this palette also addresses issues that have inconvenienced colorists grading high dynamic range programs using traditional controls. These benefits include:

– Since the controls of this palette calculate all color transformations within a perceptually uniform color space, you will experience finer control over color adjustments in a more photographically intuitive way. For example, you may find that yellow hues are easier to grade within this palette, since there's a more even distribution of hues around the circumference of the color wheels.
– The HDR palette lets you make contrast adjustments without altering image saturation, meaning that unlike when you use the master wheels of the Lift, Gamma, and Gain panel, the HDR palette lets you raise image contrast without increasing image saturation, and lower image contrast without decreasing image saturation. You’ll find this is particularly useful while boosting highlights in HDR grades, since you can now do so without causing extreme saturation increases in your highlights. In fact, all adjustments you make to contrast with these controls will adjust the image while keeping saturation unerringly constant (that is to say, perceptually speaking; you will in fact notice small saturation changes in the Vectorscope). This, of course, excludes the saturation controls.

– The HDR palette’s deep integration with Resolve Color Management also makes matching shots and copying looks from one type of media to another easier than with previous tools. Whether you’re a professional, or just getting started with color, the HDR palette will enable better results with less hassle.

Superior Temp and Tint Controls

Because the HDR palette is color space aware, the Temperature and Tint adjustments in this palette are themselves made using the same kind of XYZ to LMS color space transform used by the Chromatic Adaptation Resolve FX plug-in. The result is that Temp adjustments are photometrically accurate and create visual results similar to how the human vision system perceives changes to a scene due to a change in the color temperature of lighting.

Customizable Zones

Another unique aspect of the HDR palette is how it can be customized to suit a wide variety of working styles, specific tasks, and colorist preferences. Switching to the Zones panel reveals an interface for adjusting the Range and Falloff of each currently defined zone, using graphical controls overlaid onto a histogram of the current image, while a curve shows the user how the contrast and color adjustments they’ve made mathematically affect the RGB channels of the image within each zone. While the default zones preset provides an efficient starting point for many kinds of scenes, the varying tonal range of image data in different scenes, whether daytime, nighttime, interior, or exterior, will often require you to customize these zones to get the best results from adjustments using these controls.

The Zones panel lets you customize the tonal ranges that each set of zone controls affect.

Additionally, the sidebar at the left provides controls for adding and removing zones, so users can customize this palette to work exactly the way they want. Any customized preset can be saved for easy recall. This way, users have the freedom to work in whatever way suits them.

The Option menu provides fast access to additional ways of customizing this palette’s operation, including the selection and management of presets, a choice of methods for numerically editing Color Balance adjustments, and a setting that determines whether or not the Global controls are always exposed, or should be banked to like the other zone controls.
The HDR Palette Interface

The HDR palette is divided into two panels. The first, containing Color Balance controls and custom sliders, is for making color and contrast adjustments. The second, containing the Zones sidebar and Zones graph, is for customizing the range and falloff of each of the zones that corresponds to each set of controls found on the controls panel. It’s these zones that are used for making detailed image adjustments to tonally-specific areas of the picture.

By default, both panels appear within the same palette area, and you can switch between them using buttons at the top right of the palette. This is useful when you have limited screen real estate, or you’re making simple adjustments. Alternately, you can click a button to expose both panels side-by-side, occupying both the left and middle palette areas of the Color page.

From left to right, the Side-by-side view button, the Controls panel, the Zones panel, the Reset control, and the Option menu

This Side-by-side mode makes it easy to see and customize how each zone is mapped to the source image data, while making adjustments at the same time.

The HDR palette in Side-by-side mode; at left, the Color/Exposure/Saturation controls; at right, the Zone Customization controls

An Option menu at the far right of the title bar (shown as three dots) reveals the preset manager for this palette, as well as different GUI options for customizing how you want to use this palette.

Navigating Multiple Zones in the Controls Panel

A row of buttons just under the HDR palette’s title bar show you, of all available zones, which ones are currently adjustable using the visible controls below. While the default HDR palette preset has six zone-specific Zone controls, plus the Global controls, most users will only have room in the GUI for four sets of controls to be visible at any time. Meanwhile, grading control panel users will be constrained by how many trackballs their particular control panel has.

The Zone bank controls

Since you’ll almost always have more zones available than you have room to adjust them, this interface lets you see which zones you’re currently using, which zones are mapped to a control panel, and which other zones are available for you to switch to. By default, there are three active zones shown at the top, corresponding to the three sets of Zone controls to the left of the Global controls. Zones that
are available, but hidden, are shown in gray to the left and/or right of the currently visible zones, which appear in color. This way, you can bank back and forth among three zones at a time, while always having the Global controls available for adjustment.

There’s also a setting in the HDR palette’s Option menu, “Bank Global With Color Wheels,” that lets you use all four GUI control clusters in this palette to show Zones controls, making it faster to jump among tonally-specific adjustments. In this mode, there are four active zones shown at the top, corresponding to the four sets of Zone controls being shown. However, in this mode you must page all the way to the right to expose the Global controls, which are banked along with all the other zones.

Using these controls, you can switch your visible control among all available zones similarly to how audio mixers switch among banks of tracks with a fader panel.

**Methods of switching among different Zone controls:**

- Click any gray zone button to the left of the currently visible zones to move all zones so that the leftmost visible zone appears at that one.
- Click any gray zone button to the right of the currently visible zones to move all zones so that the rightmost visible zone appears at that one.
- Click the Left or Right Arrow buttons to either size of the zones indicators to move all zones one to the left or one to the right.

**Making Global Adjustments**

Generally speaking, if you’re using the HDR palette to do primary grading, you’ll probably want to begin with the Global controls. By default, these are found at the right of the Controls panel.

These controls let you take the initial step of making an overall adjustment to the image. To adjust color, you have a color balance wheel, temp and tint sliders (to the left and right of the wheel, and also numerically below), and saturation adjustments. To adjust image contrast, a Global Exposure control
lets you stretch overall image contrast up to brighten the image, or compress it down to darken it, relative to the current Black Offset level, which pins pixels corresponding to minimum black in place. A pair of Contrast/Pivot controls at the bottom of this palette let you manipulate overall color contrast by stretching highlights and shadows out or in relative to the pivot point, expressed in stops.

While Global color adjustments are somewhat similar to the offset, temp, and tint controls found in the Color Wheels or Log Wheels controls, there are important differences, described in detail below. The Global Exposure control, on the other hand, operates very differently from Master Offset.

**Detailed Explanation of Global controls:**

- **Global Color Balance:** A color balance control lets you simultaneously adjust the red, green, and blue channels, somewhat linearly throughout the tonal range of the image, to freely rebalance the color. However, RCMv2 automatically maintains a smooth saturation and exposure rolloff in the maximum highlights and minimum shadows, so this effect becomes less pronounced in the blackest blacks and the whitest whites of the image (this appears more pronounced in test gradients than real world images). While adjustments made with this control won’t lower the value of the darkest pixels in the image below the Black Offset level, individual color channels may dip below this level in order to preserve colorfulness in darker shadows. The resulting color adjustments made with this control are similar to how optical color filters placed over a lens would affect an image.

(Top) The original image, (Bottom) A Global Color Balance adjustment affecting the overall image, with a rolloff seen in the shadows and highlights of the superimposed ramp gradient

- **Global Exposure:** Brightens or darkens the entire image. Dragging to the right stretches image contrast by raising the highlights while keeping the shadows pinned relative to the Black Offset value. Dragging to the left lowers image contrast by lowering the highlights while keeping shadows pinned relative to the Black Offset value. For more explanation about the function of Black Offset, see the following section.

Keep in mind that all contrast adjustments in the HDR palette keep saturation constant as contrast increases or decreases. This means that, when making large contrast adjustments to HDR images, image saturation will remain perceptually the same.
– **Global Saturation**: Raises or lowers the intensity of color throughout the image. Since contrast adjustments don’t affect saturation, you must exercise manual control over any desired changes to image saturation.

– **Global Color Balance Value Fields**: Two numeric values represent how the color balance controls center handle position is represented. There are two ways of numerically showing this: as X and Y, or as Angle and Strength. You can choose either method from the HDR palette’s Option menu; whichever method you choose determines how the center handle of all color balance controls is manipulated if you adjust these values directly.

At the bottom of the HDR palette, additional Global Temp and Tint, Hue, Midtone Detail, and Contrast/Pivot controls let you make other kinds of global adjustments to image color, detail, and contrast, in ways that are very similar to the identically named controls in the Color Wheels or Log Wheels controls. Additionally, there’s a Black Offset control that lets you set the minimum allowable black level in the current shot.

**Detailed explanation of additional Global controls:**

– **Temp**: This global temp adjustment lets you warm or cool the image with a range from -4000 to +4000 based on a kelvin scale. Adjustment follows the spectral locus line in the CIE graph: the intensity of adjustment is naturalistic. To minimize visual artifacts, this control is capable of warming the image more aggressively than cooling it.

– **Tint**: This global tint adjustment lets you add “plus green” or “minus green” adjustments with a range from -100 to +100 on an arbitrary scale.
– **Hue**: Rotates all hues of the image around the full perimeter of the color wheel. The default setting of 50 shows the original distribution of hues. Raising or lowering this value rotates all hues forward or backward along the hue distribution as seen on a color wheel.

– **Midtone Detail**: When this parameter is raised, the contrast of regions of the image with high edge detail is raised to increase the perception of image sharpness. The effect is sometimes referred to as definition. When this parameter is lowered to a negative value, regions of the image with low amounts of detail are softened, while areas of high detail are left alone. 0 is unity. The range is –100 through +100.

– **Contrast**: This one parameter lets you increase or reduce the distance between the darkest and lightest values of an image, raising or lowering image contrast. The effect is similar to using the Lift and Gain master controls to make simultaneous opposing adjustments. Bright and dark parts of the image are pushed apart or brought together about a center point defined by the Pivot parameter. Unlike the Contrast control in the Primaries palette, the Contrast control in the HDR palette ignores the “Use S-curve for contrast” setting in the General Options panel of the Project Settings.

Keep in mind that all contrast adjustments in the HDR palette keep saturation constant as contrast increases or decreases. This means that, even when making large contrast adjustments to HDR images, image saturation will remain perceptually the same to your eye, with small changes made to the actual saturation of the image in order to maintain this perception. Be aware that the tone mapping settings in RCMv2 will have an effect on how much saturation is maintained in the top highlights and bottom shadows of the image, versus being automatically rolled off at the outer boundaries of the signal.

(Left) The original image, (Right) Raising Contrast, saturation is kept perceptually constant, except at the outer boundaries of the signal in the top highlights and bottom shadows (depending on how you have your tone mapping set in RCM).

– **Pivot**: Changes the center of tonality about which dark and bright parts of the image are stretched or narrowed during a contrast adjustment. This lets you change how contrast is distributed among the shadows and highlights. The default value of 0 pushes highlights above 50% gray higher, and shadows below 50% gray lower, in equal proportion to one another. Changing the pivot point changes the percentage of image tonality about which contrast is either expanded or compressed.

Darker images may require a lower Pivot value to push more levels up and avoid crushing the shadows too much when stretching image contrast, while lighter images may benefit from a higher Pivot value to push levels down and increase shadow density.
Black Offset: Defines the darkest allowable part of the image. No adjustment by any other control in the HDR palette will ever go below this level, except for the occasional color channel if the shadows become extremely saturated. For more detailed information on this extremely important control, see the very next section.

Black Offset Explained

Of all the Global controls, the Black Offset control is one of the most deceptively important. Black Offset lets you define the darkest pixels of the image. Adjustments made to Black Offset do not offset the entire signal, they only affect the very darkest portion of the signal, letting you raise or lower the black point of the image while smoothly blending the resulting adjustment into the unadjusted portion of the image. The result is that you can compress or expand the bottom of your signal.

If you raise Black Offset, you can add “flaring” to the image, similarly to how light flaring within a lens might lighten the darkest part of the image.

Alternately, you can lower Black Offset to lower the very darkest pixels in the image. If the source image is dark enough, this control can lower the darkest pixels below 0, however this image detail is preserved in the color image processing pipeline.

The most important thing to understand about this control is that level to which you set Black Offset becomes the new level at which Global exposure adjustments are made. In the following example, the first image shows the original color of a clip that was exposed to be dark. In the second image, Black Offset is adjusted to raise the darkest parts of the image, compressing them relative to the midtones and introducing a pleasing flaring effect to the shadows.
In the following image, Global Exposure is raised, and you can see in the Waveform scope that the exposure change stretches the contrast of the image up, with the darkest pixels "locked" to the Black Offset you set.

The Black Offset level you set also becomes the minimum picture level when you lower exposure, either using the Global Exposure changes, or when you use any of the “darkening” zone controls such as Shadow, Dark, and Black. The following image shows the result of lowering Global Exposure; the shadows of the image are compressed more heavily than the highlights as exposure is lowered, with the result that the minimum value of the image remains at the Black Offset level you set. With shadow detail impressively preserved, this compression rolls off smoothly and nonlinearly through the midtones so that the image continues to look as natural as possible.

This is also true when using other darkening zone exposure controls, such as the Shadow control, which selectively pushes the exposure of the darker part of the image down, while leaving the highlights alone. While reducing Shadow exposure, the darkest pixels still compress so that nothing goes beneath the Black Offset level you set.

Bottom line, you can adjust Black Offset at any time, either before or after any other Global or Zone adjustments, to fine tune the image as necessary.
Making Zone-Based Adjustments

After you’ve made whatever initial global adjustments you want, you can optionally make more tonally-specific adjustments to the image via the Zone-based color and contrast controls to the left. These divide the image into multiple overlapping “zones,” which are somewhat similar in principal to Ansel Adams’ zone system, which divides images into tonally-specific regions based on image luminance, from pure black, through progressively lighter shadows, to 18% gray as the middle value centering the midtones of most images, and then up through progressively lighter highlights on the way to the last zone of pure white.

While Adams’ zone system was meant to teach people how to think about using the available range of the photographic medium when exposing images, the zones of the HDR palette let you put this concept into practice by allowing you to make tonally-specific Color Balance, Saturation, and Exposure adjustments that only affect the range of shadows or highlights that fall within that zone.

Using the default preset, the shadows of your image are divided into overlapping Shadow, Dark, and Black zones, while the highlights of your image are divided into separate overlapping zones for Light, Highlight, and Specular ranges. The chart below illustrates the relationship of these zones to one another.

NOTE: All of the examples in this section have Timeline to Output Tone Mapping set to None, to keep the ramp gradient linear for purposes of this explanation.

Zone-Based Color Adjustments

Understanding how adjustments made using these overlapping zones interact with one another is key to knowing what you can do using the HDR palette. Keep in mind that every zone is customizable, but here’s how the default zone definitions work to let you make detailed image adjustments. For clarity, Zone adjustments are shown made to a linear ramp gradient image, to demonstrate exactly what tonal portion of each image is affected by each control.
– The Light and Shadow zones are the most broadly defined zones. Together, they cover the entire tonal range of your image. They softly overlap one another by two stops at the center of the tonal range (50% gray or 18% exposure); this is where adjustments made to Light mix together with adjustments made to Shadow, resulting in both adjustments softly blending together. Making exposure adjustments to these two zones lets you manipulate overall image contrast by selectively compressing/expanding contrast in the shadows and/or highlights relative to one another. Using the color controls lets you make broad color adjustments to the upper (highlights) and/or lower (shadows) range of image tonality.

![Color adjustments to a ramp gradient show the Light (tinted green) and Shadow (tinted orange) zones.](image)

– The Dark and Black zones overlap two progressively lower luminance ranges of the Shadow zone. Dark is useful for adjusting the color or contrast of the deeper shadows, while Black is useful as a trim that lets you manipulate the very darkest parts of an image. All adjustments you make to Dark are mixed with any adjustments made to Shadow, and all adjustments made to Black are mixed with the adjustments made to Dark and Shadow. In this way, all color adjustments you make to overlapping Shadow zones mix smoothly together to produce the final result, as seen in the following ramp gradient.

![Color adjustments to a ramp gradient show the Dark (tinted blue) overlapping the Shadow (tinted orange) zone.](image)

– The Highlight and Specular zones overlap two progressively brighter luminance ranges of the Light zone. Highlight lets you adjust the color and/or contrast of the brightest highlights, while Specular is useful as a trim that lets you manipulate the very brightest highlights of an image. All adjustments you make to Highlight are mixed with any adjustments made to Light, and all adjustments made to Specular are mixed with the adjustments made to Highlight and Light. In this way, all color adjustments you make to overlapping Highlight zones mix smoothly together to produce the final result, as seen in the following ramp gradient.

![Color adjustments to a ramp gradient show the Highlight (tinted yellow) overlapping the Light (tinted green) zone.](image)
As you can see, each one of these zones allow the specific adjustment of whichever parts of the image fall within the luminance range of that zone (as defined on the Zones panel), while providing control over how smoothly one adjustment fades into the next, to prevent unwanted contouring. As you make adjustments to the Range and Falloff of each zone using the different sets of zone controls, they work together to smoothly manipulate the contrast and color of the image, similarly to if you were using a more precise and constrained version of the Custom Curves. In fact, you can see the actual adjustment you’re making by exposing the Zone graph.

(Left) Raising the Range of the Light zone to expand the Shadow zone’s range of influence, (Right) The same adjustment seen in the Zone graph

Working this way allows a tremendous specificity of adjustment, without the need to use curves or qualifiers. For example, zone-specific Color Balance controls allow you to grade the highlights and shadows separately using the Shadow and Light zone controls to quickly create a warm/cool split lighting effect. This makes the creation of dynamic grades more efficient and more creative.

(Left) The original image, (Right) Using the HDR palette to warm the highlights and cool the shadows (exaggerated for print)

In this next example, the Dark zone’s Color Balance control is used to add a splash of green to the darker shadows of the image, while the Black control is used to neutralize this green in the very blackest shadows.

(Left) The original image, (Right) Using the HDR palette to add green to a narrow range of shadows
Zone-Based Exposure Adjustments

Each zone has its own Exposure control that allows you to stretch image contrast from that zone’s Min or Max range boundary either down towards the shadows, or up towards the highlights. As seen on the Zone graph (found on the Zone panel), exposure adjustments are made on a scale measured in stops, to provide a more photographic experience when grading wide dynamic range material.

On this scale, 0 stops corresponds to photographic 18% gray, at the center of each image’s tonal range. Shadows then fall to the left over -8 stops, while highlights fall to the right over +8 stops, where each stop represents either twice the amount of light (stopping up) or half the amount of light (stopping down).

In conjunction with Resolve Color Management, this range is designed to accommodate any SDR or HDR range you’ll be mastering to. All HDR palette controls are designed to accommodate up to 16 stops of exposure. By comparison, most modern digital cinema cameras claim to be able to capture somewhere between 13-19 stops of dynamic range, while a white paper from the ASC states that modern film negatives are capable of capturing 14 stops of dynamic range.

Unlike the Lift/Gamma/Gain or Log master level controls, the Exposure adjustment of each zone starts at a specific boundary of image tonality, and stretches all the way out through the highlights or shadows, through the maximum or minimum signal level allowable. Since Shadow and Light are the two zones that are centered on the midtones of the image, they’re the best zones for seeing how this works. Because of this, these are also probably the first two zones you’ll want to adjust if you’re making more specific exposure changes to the image.

Using the default preset, Shadow exposure adjustments affects everything in the image from stop 1 down through absolute black.

(Left) The original image, (Right) Darkening all shadows by lowering the Shadow exposure adjustment
Meanwhile, light exposure adjustments affect everything in the image from -1 stops all the way through maximum white.

This ability to make open-ended adjustments to image contrast in different overlapping ranges of shadow and highlight tonality makes these controls uniquely suitable for HDR grading, while also being completely suitable when grading at SDR levels. Also, keep in mind that all contrast adjustments in the HDR palette keep saturation constant as contrast increases or decreases. This is particularly useful when making large contrast adjustments to HDR images, for which a 300 nit expansion of highlight contrast using the Lift/Gamma/Gain or Log controls would create a huge saturation increase. Using the HDR palette to expand highlight contrast keeps image saturation perceptually the same, while offering zone-specific saturation controls that let you choose whether to increase or decrease the saturation falling within that zone.

Exposure adjustments to zones that overlap other zones are smoothly combined to allow targeted contrast adjustments, while making it relatively easy to avoid unwanted artifacts, like contouring or solarizing due to overzealous inversion of the curves caused by these operations.

**An Example of Zone-Based Exposure Adjustment**

To see this in action, let’s see what happens when we make some overlapping adjustments to the Light, Highlight, and Specular zones in order to grade some HDR highlights, focusing our attention on the Waveform scope, since it’s difficult to see HDR grades in print. Keep in mind that you won’t usually be making Zone-based Exposure adjustments by themselves. This example image has had a Contrast/Pivot adjustment to push the midtones and shadows down, to give the shadows greater definition. Then, Black Offset is raised to lift the darkest shadows up just a little bit, so they can breathe. This leaves us with an image that’s mostly under 200 nits to begin with. A perfect starting point for us to begin sculpting those highlights.

Using the default preset, making an exposure adjustment to the Light zone smoothly raises everything in the source image above -1 stops on the Zone graph. Practically, it’s stretching up all levels above 10 nits on the HDR scope. This smoothly boosts the brighter part of the image, while leaving the shadows down where we put them.
At this point, making an exposure adjustment to the Highlight zone boosts all levels above 1.5 stops on the Zone graph. Again, practically speaking, all levels above 100 nits are being boosted, brightening the top highlights. In the image, you can see that we’re creating a greater differentiation between dimmer and brighter highlights in the image, creating highlight contrast with greater detail where once there were simply flat pools of light.

Now, this might be a fine place to stop, but since we’re interested in turning the HDR in this image up to 11, we can put the highlights over the top by making one more Exposure adjustment, to the Specular zone. The Specular zone starts at 4 stops and is designed to let you boost or attenuate only the very brightest, hardest highlights, likely corresponding to specular details such as chrome reflections, eye glints, and directly photographed light sources. You won’t always use this control, but it’s useful to know about.

In this example, the default Specular Zone Min Range control is outside of the available image data in the image (seen as the right edge of the histogram in the Zone graph), so making adjustments with this control won’t do anything. However, dragging the Min Range control to intersect the end of the histogram will allow these controls to affect the very brightest pixels in the image.

Now, the Specular Exposure control lets us push the very brightest pixels of our image up, further differentiating them from the other highlights, and widening the audience’s sensation of highlight contrast.
Now, having selectively boosted the Highlight and Specular zones, you might decide that you like the differentiation that’s been created among different brightnesses of highlights, but the overall highlights are too bright. This is easily fixed by lowering the Light zone’s Exposure adjustment. As a result of this one adjustment, all of the highlights are scaled down, while the adjustments you’ve made to the Highlight and Specular zones maintain a relative influence on the parts of the image they’re brightening. The Shadow, Dark, and Black controls work similarly, but for the shadows.

Now that you’ve seen how all overlapping Zone adjustments work together to create a seamless adjustment, it’s time to look at the Zone controls in more detail.

**Zone Controls**

Each individual zone also has controls for Color Balance and Saturation, which let you make focused adjustments that fall within specific ranges of image tonality, all without needing to use a qualifier. Using all of these zones together, you can make fast, precise, and smooth adjustments to the image that feel incredibly natural. Despite the name of the palette, this allows careful adjustment of SDR images, as well as creative adjustment of the spectacular range of highlights that HDR enables. There are also Range and Falloff controls to the left and right of each cluster of controls that let you redefine each zone’s area of influence, even if the Zone graph is hidden.
– **Range indicator:** An icon and value at the upper-right-hand corner of each zone control cluster shows that zone’s range. A numeric value shows the range value, which is the Luminance level of image tonality at which that zone’s adjustment begins. This value is expressed in stops, while an icon shows you whether it’s a maximum range (affecting shadows) or a minimum range (affecting highlights).

Clicking the icon shows a temporary preview in the Viewer of which parts of the image will be affected by the controls of that zone. Affected areas appear in full color, while unaffected areas appear black.

– **Zone-specific Color Balance:** A color balance control lets you readjust the relative strength of the red, green, and blue channels within the current zone of image tonality.

– **Zone-specific Exposure:** Zone-specific Exposure controls work in conjunction with an adjustable pivot that defines the Luminance level that each exposure adjustment starts from. To accommodate both shadow and highlight adjustments, there are two kinds of pivots, labeled Maximum and Minimum range, and indicated using an icon. Max Range controls, such as the Shadow control, start at a maximum value with exposure adjustments stretching image contrast downward towards the shadows. Min Range controls, such as Light, start at a minimum value with exposure adjustments stretching contrast upwards towards the highlights. Each zone also has a falloff that specifies how much of that zone overlaps neighboring zones (starting at the pivot level) in order to blend overlapping adjustments softly enough to prevent contouring.

– **Zone-specific Saturation:** Adjusts the intensity of color within the current zone of image tonality.

– **Min/Max Range:** Defines the level of image tonality at which that zone’s adjustment starts. This value is expressed in stops. Identical to the Min or Max Range slider in the Zone panel. Useful for tweaking Range while the Zones graph is hidden.

– **Zone Falloff:** Defines how softly this zone fades into all overlapping zones. Identical to the Falloff slider in the Zone panel, the value is visible in the virtual slider below. Useful for tweaking Falloff while the Zones graph is hidden.

– **Zone-specific Color Balance Values:** Two values expose the current color balance operation numerically. The option menu lets you choose between representing these as X and Y, or as Angle and Strength.

### Customizing Zones Using the Zone Panel

Similarly to the controls of the Log palette, how these zones overlap can be adjusted in order to make each zone’s controls work best for the tonal distribution of the images in any given scene. Zone overlap is governed by individual pairs of Range and Falloff controls, so you can make precise adjustments no matter what the distribution of tonality is in the image you’re grading. All zones are organized and customized using the Zone panel, which is divided into the Zones sidebar to the left, and the Zone graph to the right.
The Zone Sidebar

The Zone sidebar show a list of all the zones in the current preset. This list is sorted by range values, with minimum range zones (affecting shadows) appearing at top and maximum range zones (affecting highlights) appearing below. Clicking any zone in the list selects that zone, which also selects that zone’s boundary handle in the Zone graph at the right.

Zone sidebar controls:

- **Enable Zone toggle**: Toggles let you turn each zone on and off. Disabled zones will not be rendered.

- **Max/Min button**: Defines whether the adjustment of a particular zone affects the image from the current range value and below (Max) or the current range value and higher (Min). This setting is typically used when creating your own custom preset, to define which zones stretch down toward the shadows and which zones stretch up toward the highlights.

- **Show/Hide Zone button**: This button lets you hide sets of zone controls you don’t want to adjust any further, leaving more room in the UI and on your control surface for the zones you do want to adjust. For example, if you decide you don’t need to use the default Black and Specular zones, you can hide them so that only the Dark, Shadow, Light, and Highlight zones are available to switch among. Zone controls with adjustments made to them continue to affect the image even if the controls are hidden.

- **Delete Zone button**: Deletes that zone. This is primarily useful when you’re creating your own zone preset. At the time of this writing, you cannot delete any of the default zones found in the default Zone preset.

Additionally, you have the option of adding zones, and saving zone presets to create your own custom ways of adjusting the image.

**To create a new zone:**

1. Open the Zones panel.
2. Click Create Zone, at the bottom of the Zones sidebar.
3. When the Create Zone dialog appears, choose the Zone type you want that zone to have (Dark/Min Zone or Light/Max Zone), enter a Name, and define the Pivot and Falloff values. Pivot, Falloff, and Zone type are editable later, so don’t worry if you don’t set them up perfectly the first time.

![Create Zone dialog](image)

4. Click Create. That zone appears added to the list, which is sorted in the order in which Pivot is defined, with Dark Zones appearing at the top, and Light Zones appearing at the bottom.
Zones Graph

The Zone graph is a key component of the HDR palette’s use. Along the bottom, a scale in stops shows the range over which the HDR palette operates. At the top, handles let you adjust the editable range boundaries that define the tonal range of each zone’s operation, superimposed over a histogram showing the current image as input into the current node. Running through the middle of the Zone graph, a curve shows you all the Global and Tonal color and contrast adjustments being made by the HDR palette in the current grade.

The Zone graph

The relationship of the range boundaries with the source image histogram in this graph is extremely important. The range boundary for a particular zone must intersect with the part of the source histogram you want to adjust for the controls of that zone to have any effect. If any zone boundaries lie outside of the histogram, that zone’s controls will do nothing. In the screenshot above, the zone’s range boundaries all lie inside of the visible histogram, so each zone’s controls will make a predictable adjustment to the image data in that part of the histogram.

In the following screenshot, the Zone graph shows that the Specular zone boundary lies outside of the source histogram for the image, so adjustments made using the Specular controls will have no effect. For this reason, it’s a good idea to check that the zone boundaries intersect the parts of the image you want to adjust prior to manipulating the controls, but if you notice that a particular zone’s controls aren’t having as much of an effect on the image as you’d like, you can always move the zone boundary after the fact to expand the range of the image that’s affected by that zone.

The Specular zone boundary lies outside of the source histogram, excluding the Specular controls from affecting the image.
Customizing zone boundaries in this way is one of the most powerful aspects of the HDR palette, but don’t worry that you’ll be constantly dragging zone boundaries back and forth for every shot you grade. Generally speaking, most well-photographed scenes have similar ranges of image tonality in each shot, so zone boundaries that have been customized for one shot from that scene will likely be good for most clips in that scene. That said, adjusting zone boundaries is another powerful way of tailoring a grade specifically for a clip with a unique range of contrast.

**Zone Controls**

- **(Min/Max) Range**: Defines the level of image tonality at which that zone’s adjustment starts. This value is expressed in stops.
- **Falloff**: Adjusts how softly the adjustment in that zone will blend into the image. A value of 0 results in an immediate transition to the adjustment created in the current zone, with the color adjustment being a sharper effect. Higher values will blend the current zone’s adjustment into the image more softly, resulting in a more gentle and seamless transition into the effect.

**Customizing and Saving Presets**

If you’ve customized the Zone graph in a way that’s potentially useful for other grading situations, you can save a preset of the Zone settings for future use. Saving, recalling, and managing these presets is simple.

**Methods of managing presets:**

- **To save a preset**: Customize the Zone graph to suit your needs, then choose Save As New Preset from the HDR palette Option menu.
- **To load a preset**: Choose Presets > Name of Preset > Load Preset from the HDR palette Option menu. A new preset will be saved.
- **To update a preset**: Load a preset, make any changes you need to from the Zone graph, and then choose Presets > Name of Preset > Update Preset from the HDR palette Option menu.
- **To delete a preset**: Choose Presets > Name of Preset > Delete Preset from the HDR palette Option menu.

**Resetting Color and Zone Adjustments**

In the HDR palette’s Option menu, there’s a Reset submenu with three commands, Reset All, Reset Color Adjustments, and Reset Zone Definitions, which are self-explanatory. These are important because, during the course of developing a grade, there will be many times when you’ll want to reset your color adjustments without changing how you’ve customized the Zone graph, or vice versa.

Additionally, each of the visible reset buttons in the GUI can be used with keyboard modifiers to specifically target what to reset. The master reset button in the HDR palette’s title bar resets the entire palette when clicked (similar to the Reset All command). However, using keyboard modifiers while clicking this button changes what’s reset.

- Hold down Command+Shift while clicking the master reset button to reset only the Zone graph’s Range and Falloff controls, without resetting your color adjustments.
- Hold down Command+Option while clicking the master reset button to reset only the color adjustments, while leaving the zones alone.

Both of these modifiers also work with the zone-specific reset controls found in the Wheels panel, letting you reset only the Zone controls or only the Color controls of each specific zone.
Using the HDR Palette With DaVinci Control Panels

To use the HDR palette with the original DaVinci Advanced control panel, press SHIFT + AUTO COLOR.

To use the HDR palette with the DaVinci Advanced control panel’s 2020 layout, press HDR on the Trackball panel.

Once selected on the Advanced control panel, all of the current control mappings will appear in the center panel soft buttons and rotaries, and the trackballs and control rings will be mapped to the appropriate zones. The < and > soft keys let you navigate among all the zones available in the current preset.

To use the HDR palette with the DaVinci Mini control panel, press the USER button, then press the HDR soft button above the left-hand display. All of the HDR palette control mappings will appear in the soft knobs and keys, and the trackballs and control rings will be mapped to the color balance and exposure controls of the appropriate zones. The PREV ZONE and NEXT ZONE soft keys let you navigate among all the zones available in the current preset.
Chapter 131

Primary Grading Controls

This chapter focuses on the more esoteric adjustments you can make, mixing colors between channels using the RGB Mixer.

Contents

Introduction to the RGB Mixer Palette 2623
Preserve Luminance 2623
Resetting the RGB Mixer 2624
Swap Channels Buttons 2624
Using the RGB Mixer in Monochrome Mode 2624
Introduction to the RGB Mixer Palette

The RGB Mixer palette lets you remix different amounts of image data from one channel to another, and has a wide variety of creative and utilitarian uses. Furthermore, the RGB Mixer can be used either to remix the color channels, or to add different proportions of each color channel into a monochrome image.

By default, the RGB Mixer palette is set to mix any amount of the Red, Green, and Blue color channels into any of the other channels. Each color channel has a dedicated control group of Red, Green, and Blue sliders that you use to do the mixing, and the default values of these can be seen in the screenshot above.

Each slider has an overall range of –2.00 to +2.00. This means that you also have the option of subtracting any combination of color channel values from a particular channel. For example, you can lower the Red control group’s Green slider to –.24 to subtract 24 percent of the Green channel from the Red channel.

Preserve Luminance

With the “Preserve Luminance” checkbox turned on, any channel adjustment you make is prevented from altering the luma of the image by automatically raising or lowering the other two channels to compensate. In the following example, you can see that when “Preserve Luminance” is turned on, lowering the Green control group’s Green slider results in the Red and Blue channels being raised by the same amount (as seen in the Parade scope). Conversely, raising a color channel’s slider ends up lowering the other two channels by the same amount to keep overall image luminosity the same.
Resetting the RGB Mixer

Clicking the Reset button at the top right-hand corner of the RGB Mixer resets each slider to its default position, where Red = 1.00 for Red output, Green = 1.00 for Green output, Blue = 1.00 for Blue output, and all other sliders = 0.

Swap Channels Buttons

A set of three buttons at the bottom of the RGB Mixer lets you easily swap two channels with one another. This can be useful as part of a creative look, or corrective in instances where two channels are accidentally reversed.

– Swap Red and Green: Swaps these two color channels.
– Swap Green and Blue: Swaps these two color channels.
– Swap Red and Blue: Swaps these two color channels.

Using the RGB Mixer in Monochrome Mode

When you turn on the Monochrome checkbox, two of the sliders within each Output group are disabled. This leaves the Red > Red slider, the Green > Green slider, and the Blue > Blue slider as the only available controls.

Keeping in mind that each of the color channels that makes up an image is itself a grayscale channel, the RGB sliders in Monochrome mode let you add different proportions of the Red, Green, and Blue color channels together to create custom grayscale versions of a shot.

To understand why this is useful, let’s consider the default values of the Red, Green, and Blue sliders. To emulate the human eye’s sensitivity to the wavelengths of light, the Rec. 709 video standard defines an isolated Luma (Y’) component as consisting of 0.2126 of the Red channel, 0.7152 of the Green channel, and 0.0722 of the Blue channels added together. This can be seen in the default values (rounded to the nearest integer percentage) of 21, 71, and 7.

This is the standard method of deriving a black and white version of a color image, and in fact produces identical results to those obtained by setting the Saturation parameter to 0.
However, there have traditionally been other ways of mixing the colors of life into different grayscale interpretations. For example, photographers often use colored filters in conjunction with black & white film stocks, such as a yellow/green filter to emphasize pleasing skin tone for lightly complexioned people. A much older example is the use of black & white film stocks with different sensitivities (old orthochromatic stocks were not sensitive to red wavelengths, recording only blue and green to create an image).

Using the RGB Mixer with Monochrome mode turned on gives you the ability to mix your own custom blends of all three color channels to emphasize the creative characteristics you require. For instance, increasing the mix of blue and decreasing red and green can give skin tones a darker, metallic sheen. The following screenshots show multiple versions of the same image with different monochrome mixes.

Three monochrome mixes of the same image. The top image is the result of setting saturation to 0.

Like the parameters in Color mode, you can use the RGB Mixer’s Monochrome mode to subtract one color channel from the others, for even more creative effects.
Chapter 132

Curves

The Color page has a powerful curves interface that provides controls for adjusting color and contrast with the Custom Curves, as well as a variety of “Hue” or “HSL” curves that let you make more targeted adjustments to hue, saturation, and luminance in a variety of ways.

Contents

Introduction to Curves 2627
Adjusting Curves Using the Mouse 2627
Sampling Images to Place Control Points on Curves 2629
Showing Picker RGB Values 2629
Curves Histograms 2629
Custom Curves 2630
Editing the Top and Bottom Control Points of Curves 2631
HDR Grading Using Curves 2632
Enabling Editable Splines in the Custom Curves 2633
Adding Default Anchors to the Custom Curves 2633
Ganging and Unganging Custom Curves 2633
Copying Custom Curves From One Color Channel to Another 2634
Curve Intensity Sliders 2634
YSFX Sliders 2635
Soft Clip 2635
Ganging and Unganging Soft Clip Controls 2636
Soft Clip Controls 2636
The HSL Curves 2638
Image Sampling for Hue and Sat Curves 2640
Additional Controls in the Hue and Sat Curves 2640
Hue vs. Hue 2641
Hue vs. Sat 2641
Hue vs. Lum 2641
Introduction to Curves

The Curves palette, selectable via one of the toolbar buttons above the Center Palette panel of the Color page, has six modes that provide different curve-based methods of manipulating the color and contrast of an image. Each curve lets you adjust a customizable region of the image based either on image tonality (zones of lightness or darkness), hue (specific colors), or saturation (intensity of color). All curves can be adjusted using either the pointer, or knobs on the DaVinci Resolve Mini or Advanced control panel.

The Curves palette is color-space-aware when you’re using Resolve Color Management (RCM) or ACES. What this means is that the overall range of each curve better fits the overall data range of the current clip no matter what Timeline Color Space you’re using, for both SDR and HDR mastering. This makes curves adjustments easier, more specific, and a more consistent experience, no matter what your workflow happens to be.

TIP: All curves in DaVinci Resolve can be used to affect the overall image, or limited to affect only a specific portion of the image as a part of a secondary operation using qualifiers, windows, imported mattes, or any combination of the three.

Adjusting Curves Using the Mouse

All Color curves in DaVinci Resolve use the following controls for basic on-screen adjustment using the pointer, controlled either with your mouse, pen, or other input device of choice.

Methods of adjusting curves using the on-screen interface:
- **To add a control point**: Click anywhere on a curve. A control point is added at the position of the mouse where you clicked, and the curve is altered, if necessary, to match the new control point’s position.
- **To add a control point without altering the curve**: Hold the Shift key down, and click anywhere on or around a curve. A control point is added to the curve at the position of the pointer where you clicked, but the curve is not altered.
- **To snap a control point to the neutral diagonal of the curve**: (Custom curve only) Hold the Option key down while dragging any control point on the curve. A diagonal line appears indicating the neutral state of the image, and the control point will snap to it. When you release the Option key and then press the Option key again after releasing, the diagonal guide line disappears.
– **To remove a control point**: Right-click any control point to make it disappear.

– **To reset a single color channel curve to a completely neutral setting**: Click the reset button to the right of that color channel’s intensity slider.

– **To reset all color channel curves**: Click the Reset Custom Curve button at the upper right-hand corner of the Curves palette.

By default, a control point influences the portion of each curve that falls between its neighboring two control points.

![Control point adjustments affect the entire portion of a curve between adjacent control points.](image)

In the top screenshot, you can see that the control point at the position of the pointer is affecting the larger part of the curve that falls between the lower left-hand control point (which is there by default), and a user-created control point placed up within the highlights of the curve.

In the bottom screenshot, an additional control point to the left of the one being adjusted limits the area of the curve that is adjusted. By careful placement of additional control points, you can make extremely targeted adjustments to images using the Custom curves.

This example highlights the importance of using control points to “lock off” portions of a curve at a neutral or nearly neutral position to prevent changes to specific portions of an image, even while using other control points to make changes.

**NOTE**: The HSL curves also have an optional adjustment mode using Bezier curves that will be covered in those sections.
Sampling Images to Place Control Points on Curves

Another way you can add control points to curves is to move the pointer to the Viewer, and click to sample a color value and place a control point at the position on the currently open curve that corresponds to that value. This works with Custom, Hue, and HSL curves.

Clicking on a feature of the image

Creating a control point on the currently open curve

Showing Picker RGB Values

While you’re dragging the pointer over the Viewer and looking for a feature to sample, you can enable a tooltip that shows you the RGB Value of the pixel under the pointer by right-clicking the Viewer and choosing Show Picker RGB Value to toggle this feature on and off. When you turn this feature on, the View > Show RGB Picker Values in submenu has options for displaying either 8- or 10-bit tristimulus values.

The color picker tooltip that appears when you turn on Show RGB Picker Values

Curves Histograms

The Custom curves and HSL curves all show a histogram that represents the input of the currently selected Correction node, which you can use to guide your adjustments. The Histograms submenu of the Curves palette’s Option menu lets you choose to disable these histograms, or to switch the histograms between showing the input or the output of the node. If you switch to Output, the histograms will update to show you the result of your adjustments, at the expense of seeing the image data that the curve is actually working upon.
The Custom curves show a YRGB histogram:

The histogram appearing underneath the Custom Curves shows a YRGB histogram analysis.

Each Hue or HSL curve shows a histogram analysis of the two color channels that Curve acts upon: hue against saturation level, luminance against saturation level, or saturation level against saturation level, to give three different examples. In the case of Hue or HSL curves, these histograms make it easy to see which parts of the Curve controls will actually affect image data.

The histogram appearing underneath the Hue vs Sat curve plots all saturation levels at each value of hue.

Custom Curves

DaVinci’s Custom curves provide smooth adjustment of each clip’s Y, R, G, and B channels.

The Custom curve mode of the Curves palette is divided into two areas, the Curve Editor to the left, and the Curve controls to the right. The editor contains the actual Curve controls you use to adjust the image. The controls at the right let you choose which curves you’re adjusting, and adjust their intensity.

The Custom curves seen used to create a gentle “S” curve adjustment with four additional control points added; the left point is selected.
The Custom curves are useful for making more tonally specific, channel-by-channel adjustments to an image than can be accomplished using the Color Balance controls. They’re also useful for making strange and wonderful stylistic adjustments through unusual alterations to different combinations of color channels.

Although the ganged Custom curves appear to be a single curve control, the Custom curve editor is actually presented as a series of overlaid curves, and the YRGB curves all appear within a single editor. The default, neutral position of the Custom curves is a diagonal line that runs from the lower-left black point of the image through the upper-right white point.

The neutral diagonal position of the curve at which no adjustment is made

The horizontal axis represents the range of image tonality in the original image, from black (at the left) to white (at the right), while the vertical axis represents the range of alteration you can make. By adding control points to the surface of the curve and raising or lowering it at different regions, you are actually remapping the original horizontal “input” value of a color channel to an “output” value of your choosing.

Additional controls appear to the right of the curve editor itself. A top row of buttons let you select the curve corresponding to an individual color channel for isolated adjustment, while a vertical stack of four sliders let you adjust the intensity of each color channel’s curve.

Editing the Top and Bottom Control Points of Curves

You can also edit curves using the default two control points that the curve control starts out with in the Curve Editor. The Black Point control (at the lower-left) and the White Point control (at the upper-right) let you expand and compress the video signal similarly to using the Lift and Gain Master Wheel controls in the Color Wheels palette.
You can use the Black and White Point controls in the following ways:

- **Using the Black Point control**: Dragging this control up makes a lift adjustment to raise the black point of the signal. Dragging this control to the right makes a lift adjustment to lower the black point of the signal.

- **Using the White Point control**: Dragging this control down makes a gain adjustment to lower the white point of the signal. Dragging this control to the left makes a gain adjustment to raise the white point of the signal.

**HDR Grading Using Curves**

When using various grading controls in the Color page to grade wide-latitude images for HDR output, you may find it useful to enable the HDR mode of the node you’re working on by right-clicking that node in the Node Editor and choosing HDR mode from the contextual menu (only available in Resolve Studio).

This setting adapts that node’s controls to work within an expanded HDR range. Practically speaking, this makes it easier to work with wide-latitude signals using controls that operate by letting you make adjustments at different tonal ranges such as Lift/Gamma/Gain, Custom Curves, Soft Clip, and so on.
Enabling Editable Splines in the Custom Curves

When the Curve palette is in Custom mode, you can choose Editable Splines from the option menu to expose Bezier spline handles on any selected control point, which let you make more precise curve adjustments whenever necessary.

![Custom curve with editable splines enabled](image)

**NOTE:** Beware of making curve adjustments that are too sharp, or with control points that are too close together, as they can introduce unwanted contouring within the image, causing flattening or solarization in parts of the image that you may not want.

Adding Default Anchors to the Custom Curves

You can also choose Default Anchors from the option menu of the Curve palette in Custom mode to place three additional control points on the curve, dividing the curve into five segments that affect the shadows, low midtones, medium midtones, high midtones, and highlights of the image.

![Custom curve with Default Anchors exposed](image)

Ganging and Unganging Custom Curves

By default, the Custom curves are ganged, so that curve adjustments affect a clip’s YRGB channels all together, resulting in an adjustment to image contrast that’s similar to using the Master Wheels in the Color Wheels palette. When making this type of adjustment, increasing contrast also increases image saturation, while reducing contrast also reduces image saturation. Since curves can be manipulated with greater specificity than the three Master Wheels, you can make much finer contrast adjustments using the YRGB curves than when using the Master Wheels only.

Turning ganging off lets you use the full power of Custom curves to alter the image. Unlike the Color Balance controls, each of which adjust all three color channels simultaneously, the Curve controls let you adjust each channel individually when Gang Custom Curves is turned off.

**To disable Custom curve ganging:**
- Click the Curve Edit button that corresponds to the curve channel you want to edit. Clicking any Curve Edit button highlights that curve to make it easy for editing when curves overlap one another. Once one or more curves is offset from the others, you can freely edit any curve by dragging its control points.
To re-enable Custom curve ganging:

- Click the Gang button to the left of the Curve Edit buttons.

Editing color channels via individual curve adjustments lets you make smooth color-channel specific corrections, or you can make radically individual adjustments to create a wide number of creative effects.

**TIP:** When curve ganging is disabled, the Luma curve allows you to adjust the Y channel by itself, which is similar to using the Y-only Lift/Gamma/Gain knobs of the DaVinci Resolve Micro, Mini, or Advanced Control Panels. When making this type of adjustment, increasing luma contrast results in a perceptual decrease of image saturation.

Copying Custom Curves From One Color Channel to Another

Even if you’ve unganged the Custom curves, you can still mirror one curve’s adjustments to another by copying it using the “Copy to Red/Green/Blue” commands in the Curve palette’s option menu.

**Curve Intensity Sliders**

Four Curve Intensity sliders to the right of the Curve Editor, one for each channel, let you mix between the current curve’s effect on the clip, and the original state of the image before you altered the curve. The default Intensity of 100 results in that curve exerting its full effect on the image, while an intensity of 0 results in that curve having no effect on the image. The Intensity sliders provide an easy way to “split the difference” between a curve adjustment and the previous state of the image.

Lowering the Curve Mix slider reduces the effect of that curve’s adjustment on the image.
YSFX Sliders

Each of the Custom curves (Y’, R, G, and B) has a vertical YSFX slider at the upper left-hand corner of the Curve Editor that lets you invert any or all color channels by any amount you want, to create different types of stylized effects.

![Image with the Luma channel modified using the vertical YSFX slider](image)

As with all other adjustments in the Color page, YSFX may be combined with Power Windows or HSL qualification to limit channel inversions to specific portions of the image for creative purposes.

Soft Clip

The Soft Clip controls consist of four sliders underneath the Curve controls of the Custom curves, and give you an interface for adjusting highlight and shadow soft clipping either overall, with Ganging enabled, or on a per-channel basis. The Soft Clip controls are intended to provide clip-by-clip adjustment, as opposed to the Generate Soft Clip LUT settings, which let you set one soft-clipping setting for the entire program. For more information on the Soft Clip LUT setting, see Chapter 4, "System and User Preferences."

![High and Low Soft Clip controls within the Curves palette](image)

Soft clipping lets you apply a "knee" to any clipping that occurs at the upper or lower extremes of the image, and can be used to quickly ease off any unpleasantly harsh loss of detail that occurs as a result of blowing out the highlights or crushing the shadows too aggressively.

In the following example, the screenshot at top has had the highlights deliberately blown out by excessively boosting the highlight contrast. As you can see, the edges of the clipped area lack detail. The screenshot at bottom shows the same image with soft clipping increased for all three color channels. The result retrieves detail, compressing the highlights to bring the tops of each color channel back within the allowable range.
Ganging and Unganging Soft Clip Controls

Soft clipping can be simultaneously applied to all three color channels by enabling the Ganging control (on by default), or you can disable Soft Clip ganging to individually adjust each channel. For example, using soft clipping on individual channels can be useful for legalizing RGB out-of-gamut errors for channels that over- or undershoot your QC standards.

To disable Soft Clip ganging and edit soft clipping for individual color channels:
– Click the channel control button corresponding to the color channel you want to edit, and then drag the sliders to create the desired adjustment.

To re-enable Soft Clip ganging:
– Click the Ganging control to the left of the Soft Clip channel controls.

**TIP:** Applying too much soft clipping to individual color channels may add an unwanted color tint to the corresponding highlights or shadows of an image. To avoid this, use the soft clipping parameters with ganging enabled to clip all three color channels equally.

Soft Clip Controls

Whether all channels are ganged or not, soft clipping is controlled via two sliders and two additional parameters for each color channel.

**High**

The High Clipping Point slider lets you adjust the maximum signal level above which the signal is clipped. Any pixels above the clipping level are made equal to the clipping level.

The High Clipping Point defaults to a digital level of 1023 relative to the DaVinci Resolve internal video scopes. Dragging this slider to the left causes the highlights of the image to clip at a lower level, resulting in lower, dimmer maximum levels.
Selecting and adjusting the high clip

RGB Parade displays the clipped image

At the default position, no clipping occurs and image data that you push above 1023 on the internal scopes is preserved and passed through the image processing pipeline to subsequent nodes. For example, in the following two screenshots, the highlights in the screenshot at top are blown out raising the gain dramatically in Node 1. In the screenshot at bottom, a subsequent adjustment in Node 2 lowers the gain and retrieves all the previously clipped values.

The image is clipped using the Gain control in Node 2

The image data that was clipped in Node 1 is retrieved in Node 3 by lowering the Gain control. This illustrates the preservation of deliberately clipped data.
However, if at any point in a node tree you drag the High Clip slider to the left, even by a single digit, all image data above the new clipping threshold is discarded from that node forward. In the following example, the High Clip slider in Node 1 is lowered. The result is that all clipped image data is discarded. As a result, when Node 2 lowers the gain, there is no image detail left to retrieve, and all three channels exhibit flattening.

![Image of image data before and after clipping](image)

Lowering the High Clip slider in Node 1 forces all image data above the new High Clip threshold to be irretrievably discarded. Clipped data cannot be brought back by subsequent nodes.

**High Soft**

The High Soft slider sets the threshold, below the clipping point, at which highlights begin to compress before hard clipping. At unity, no soft clipping occurs. As you raise this value, more and more of the clipped highlight values are compressed, rather than clipped, resulting in softer, more pleasant “glowing” highlights.

**IMPORTANT**

Image data that was clipped “in camera” is not necessarily retrievable using the Soft Clip controls, although there may be some preserved overhead in the super-white highlights of Y’CbCr-encoded video data.

**Low**

The Low Soft Clipping Point slider lets you adjust the minimum signal level at which the signal clips. This defaults to a digital level of 0 relative to the DaVinci Resolve internal video scopes. Dragging this slider to the right causes the shadows of the image to clip at a higher level, resulting in lighter minimum levels, and a lower-contrast image with lighter (possibly milky) shadows.

**Low Soft**

The Low Soft slider sets the threshold, above the minimum clipping point, at which shadows begin to compress before hard clipping. At unity, no soft clipping occurs. As you drag this slider to the right, more and more of the clipped shadow values are compressed, rather than clipped, resulting in a softer, more pleasant rolloff in the shadows.

**The HSL Curves**

Three sets of Hue curves, and additional Lum vs. Sat and Sat vs. Sat curves, let you make different types of curve-based alterations to the image. Whereas the Custom curves let you make adjustments to the color channels of an image based on tonality (for example, boosting the Red channel in the highlights while lowering it in the shadows), the Hue curves let you make adjustments to the hue, saturation, or luma of elements in an image based on their hue.
Curves controls including six-vector selection and bezier handle button

For example, you could use the Hue vs. Sat curve to selectively lower the saturation of everything that's blue, while raising the saturation of everything that's red.

You can use these curves to make adjustments similar to those made using HSL qualification, but with one critical difference. Curve adjustments are mathematically smoother than the matte-limited adjustments of HSL qualifiers, so it can sometimes be easier to make specific alterations that blend smoothly with the rest of the image, without the potential for artifacts at the edges of qualified keys that can sometimes defeat a seamless result.

On the other hand, it is often easier to define more distinct boundaries between separate elements using HSL qualification. Only time and experience will help you determine which tools are best for which situations.
Unlike the Custom curves, which default to a diagonal position where lower left represents the black point and upper right represents the white point, Hue and Sat curves are flat. In the case of the Hue vs. Hue/Sat/Lum curves, the horizontal range of the curve from left to right represents the overall range of possible hues, from red through green through blue and then cycling back to red.

Because the range of hues cycle smoothly from the left to the right edge, changes that affect the curve near the left boundary of these curves loop smoothly around to the right boundary, and vice versa, such that the left and right sides of the curve always move together (as you can see in the above screenshot).

**IMPORTANT**

When using Hue curves, the range of hue that you isolate with control points is always relative to the RGB input connected to that node. That means if you change the hue of a shirt from blue to red using Hue vs. Hue and you then want to raise the same shirt’s saturation with the Hue vs. Sat curve within the same node, you need to add control points to the same range of blue for both curves.

**Image Sampling for Hue and Sat Curves**

There’s an additional way to use Hue curves in DaVinci Resolve. Whenever one of the Hue vs. Hue, Hue vs. Sat, Hue vs. Lum, Lum vs. Sat, or Sat vs. Sat curve tabs are open, clicking or clicking and dragging over any range of pixels within the Viewer area samples the hues and/or image tonality of that region of the picture, and automatically places three control points on the currently open curve that correspond to the range of color and contrast you sampled. This also works if you use the cursor from the DaVinci control panel with the fourth trackball to sample a range of color.

**Additional Controls in the Hue and Sat Curves**

While the Hue vs. Hue, Hue vs. Sat, Hue vs. Lum, Lum vs. Sat, and Sat vs. Sat curves can be adjusted similarly to the Custom curves, they have additional controls running underneath the curve graph.

- **Enable Bezier button:** Turning this button on forces a curve to use Bezier control handles, rather than the default DaVinci Resolve Curve Control points, to manipulate each control point on the curve. With Bezier handles enabled, click any control point to reveal its two Bezier handles. Drag either handle to alter the shape of the curve at that control point.

- **Six-Vector Color Patches:** The Hue curves each have six buttons for automatically adding control points to manipulate the red/yellow/green/cyan/blue/magenta ranges of hue. Clicking any of these buttons adds three control points; two to define the outer range of hue to be adjusted, and a middle control point that you use to make the adjustment.

- **Input and Output (Hue Rotate/Saturation/Lum) fields:** These two number fields correspond to the horizontal and vertical adjustment values for the currently selected control point. Click any control point on a curve to view or alter these values. The label of the second field depends on the curve that’s selected.

The following sections describe each available curve in more detail.
**Hue vs. Hue**

The Hue vs. Hue curve lets you change any hue to any other hue. In the following example, the image on the left is the unadjusted original. The image on the right has had the orange jacket shifted to an olive green via a set of three control points.

![Changing the hue of the woman's jacket using the Hue vs. Hue curve; Left–original image, Right–altered image](image)

One excellent use of the Hue vs. Hue curve is to quickly and subtly alter elements that require only minor adjustments. For example, a sky that appears a bit too cyan can be made into a richer shade of blue with a small adjustment.

Hue vs. Hue is also useful for making more radical changes to elements that might be too noisy to key successfully using the HSL qualifier controls. For example, red autumnal foliage blowing in the wind might result in a chattery matte, but you can use the Hue vs. Hue curve to change reds to greens, without having to worry about aliased matte edges giving your correction away.

**Hue vs. Sat**

The Hue vs. Sat curve lets you selectively alter the saturation of any hue within the image. This is a terrific tool for creative effect, allowing you to quickly and easily boost the saturation of elements you want to catch the viewer’s eye, while reducing the saturation of elements you’d prefer the audience not dwell upon.

This can be extremely useful for legalizing over-saturated overshoots or undershoots during a QC pass. For example, desaturating reds that are off the charts while leaving everything else alone.

![Lowering the saturation of the woman's jacket using the Hue vs. Sat curve; Left–original image, Right–altered image](image)

The Hue vs. Sat curve can also be a powerful tool for increasing the color contrast of images that seem lackluster and flat. By boosting the saturation of colorful elements that are distinct from the dominant palette of a scene, you can add variety to an otherwise monochromatic image.

**Hue vs. Lum**

The Hue vs. Lum curve lets you increase or decrease the lightness of elements of specific colors.
Darkening the woman’s jacket using the Hue vs. Lum curve; Left–original image, Right–altered image

This is a tricky curve to use with highly compressed footage, as it can quickly reveal artifacts in the image if you aren’t careful. However, if you’re working with very high-quality footage, this can be a great tool to darken specific hues to add richness and depth, or to lighten colorful elements to which you want to draw attention.

**Lum vs. Sat**

The Lum vs. Sat curve is similar to the Custom curves in that alterations to the saturation of an image are based on user-definable ranges of image tonality, rather than hue. In the following example, the Lum vs. Sat curve is being used to decrease selectively the saturation of everything falling into the highlights and shadows of the image, while increasing the saturation of everything within the midtones.

In the following example, a vividly saturated treatment results in shadows that seem artificially colorful. Using the Lum vs. Sat curve, it’s easy to gradually desaturate everything below a certain range, with a nice smooth falloff.

This is an outstanding curve to use for creative effect, for example, slightly boosting saturation within the midtones while reducing saturation in the shadows to increase the depth of the darkest portions of the image. It’s also a great curve to use to solve QC violations. For example, if you have illegal saturation in the highlights of an image, you can use the Lum vs. Sat curve cleanly and smoothly to lower the specific values that are causing problems.
**Sat vs. Sat**

The Saturation vs. Saturation curve lets you selectively manipulate image saturation within specific regions defined by the image’s original image saturation. Control points added to the left of this curve affect areas of progressively lower saturation, effectively letting you increase or decrease the saturation of lower-saturated features. Control points added to the right affect areas of progressively higher saturation, letting you increase or decrease the most saturated features of an image.

Like all curves, this operation is extremely useful for stylizing the image. You can create custom vibrance operations, where you selectively increase the saturation of low-saturated regions of the image in different ways to give the picture more “pop.” It’s also an excellent tool for taking care of over-saturated areas of the picture when adhering to conservative QC requirements. You can specifically desaturate only the most over-saturated parts of the picture, without affecting similar hues at lower levels of saturation.

In the following example, you can see that the portion of the image with the highest saturation has been desaturated, while the rest of the image has been left alone.

**Sat vs. Lum Curve**

The inverse of the Lum vs. Sat curve, Sat vs. Lum lets you quickly adjust the luminance of pixels that falls within a particular range of saturation. This is useful for cases where regions of the image you want to make lighter or darker happen to coincide with an identifiably consistent range of saturation.

To help guide your adjustment, the histogram drawn for this curve lets you see how many pixels there are at each level of saturation found within the image, with the leftmost part of the curve representing minimum saturation, and the rightmost part of the curve representing maximum saturation. Seeing where the levels of saturation lie in the current image help you to quickly make targeted luminance adjustments when you sample the region of the image you want to adjust to add points to this curve.
In the following example, the right side of this curve is lowered so that the most saturated parts of the image become darkened. You might want to make an adjustment like this to emulate one of the properties of film, where highly saturated colors block more light from passing through the emulsion than less saturated colors. Or, you may do this in an effort to desaturate bright colors in highlights that might otherwise clip past maximum white. Or, you might do this to quickly darken highly saturated skies.

(Top Left) The original image, (Top Right) The highly saturated blue sky and sea reflections are darkened to a more intense blue by lowering the right part of the Sat vs. Lum curve (Bottom).
Chapter 133

Color Warper

The Color Warper is a powerful tool for making both highly specific adjustments to particular things in the frame, and widely general adjustments to create unique looks. The two modes of the Color Warper each make it easy to simultaneously modify two different color attributes, either saturation and hue, or lightness and hue. This gives the Color Warper an advantage over curves, which only let you adjust one color characteristic at a time. In this chapter, you’ll learn how to use both modes of the Color Warper to perform a wide variety of tasks.

Contents

Introduction to the Color Warper 2646
The Color Warper Interface 2648
Using the Grid Controls to Manipulate Color 2648
Previewing Which Colors Are Warped By Each Control Point 2651
Sampling to Warp Colors 2651
Resetting Grid Points 2652
Grid Resolution Affects The Specificity and Quality of Adjustments 2653
You Can Warp Color in Different Color Spaces 2654
Hue – Saturation Controls 2654
Tools 2655
Modifiers 2656
Range 2656
Auto Lock Controls 2656
Smoothing Controls 2656
Chroma – Luma Controls 2657
Axis Angle 2658
Tools 2658
Modifiers 2659
Range 2660
Auto Lock Controls 2660
Smoothing Controls 2661
Introduction to the Color Warper

The Color Warper palette is a mesh-based warping tool that, instead of warping the spatial location of pixels, warps one set of colors into another. Better yet, unlike the HSL curves, the Color Warper lets you simultaneously adjust two color parameters at the same time, within user-selectable regions of specific hues. These adjustments, made using a grid of draggable control points, automatically have a smooth falloff from the colors you’re warping to other colors that are locked into place. The smoothness of this falloff depends on the distance between the warp points that are being adjusted and other warp points that are locked in place to prevent change.

The Color Warper, located in the center palette area

There are two ways you can use this tool. You can drag the control points in the grid to make highly specific image adjustments. More intuitively, you can click to sample the image, which selects the closest grid point that affects that color, and then drag to make an adjustment with that control point.

Clicking and dragging to sample skin tone in the Viewer to adjust that color’s control point on the Hue-Saturation warping grid

You can use this tool to make extremely specific adjustments to colors in an image, similar to what you might do with a Qualifier key or with the HSL curves. However, by warping the points using a grid, you can manipulate two color characteristics at the same time, adjusting both hue and saturation, or chroma and luma. In the following example, specific adjustments are being made to refine the woman’s shirt, to adjust her skin tone, and to manipulate the greens of the foliage in the shot. All three of these naturalistic adjustments are smooth and artifact-free by virtue of the Color Warper’s method of cleanly remapping color.
You can also use this tool to create wide-ranging stylistic looks for the overall image, bending the color in creative ways that other controls don’t. In the following image, the less saturated and neutral colors of the image are all warped towards a bluish-cyan, while the more saturated oranges are warped towards a saturated orange-red, to quickly create a stylistic treatment of the image.
The Color Warper Interface

You can either use the Color Warper as it appears docked into the middle palette area, or you can click the Expand button to open the Color Warper into a floating window that you can make as large as you like, giving you more detailed control of dense grids of control points. For convenience, the examples in this chapter show the Color Warper side-by-side with the Viewer, in a floating window. While the Color Warper is open in its own window, the Color Warper palette button in the toolbar turns into a “re-docking” button, clicking it puts the palette back in the palette area below.

There are two overall regions of the Color Warper palette. At the left, the grid area has the actual warping grid with points you manipulate to make adjustments, while controls underneath let you choose the resolution of the grid and the color space in which it works. At the right, the control area provides all the tools, range controls, and feathering controls that are available for manipulating the warping grid in a variety of highly specific ways.

Using the Grid Controls to Manipulate Color

This palette has two modes; each lets you manipulate the colors of the image in different ways, and each has a different style of grid used for warping the different color channels that are affected. Learning how to manipulate the color warping points of each of these grids is central to understanding how this palette works.

Dragging to Warp Colors

Despite the different shapes, each of these grids are manipulated in similar ways. Dragging a control point alters whatever color corresponds to that point, while the colors that surround this dragged point are also adjusted proportionally according to their location between the point being dragged and surrounding points that either (a) aren’t affected, or (b) are locked into place. Locked points prevent the colors at those points from being changed. By locking some parts of a grid and dragging other parts, you can create sophisticated hue-specific adjustments.
The orange control point has been selected and dragged to make an adjustment. Control points with black outlines are locked in place and help prevent control points on the opposite side from being moved. All other control points between the selected and locked control points are stretched or squished depending on the selected point’s adjustment.

The image above shows the three states of control points in the grid:

- **Orange**: Selected points appear orange. You can select multiple points by Command-clicking multiple points, by dragging a bounding box over multiple points, or by using the draw selection tool to click and draw over any points you want to select. Once you’ve selected and moved a control point, it becomes locked to keep that adjustment in place.

- **Outlined**: White control points with a black outline are locked. Locked points do not move automatically when nearby points are dragged, so locked points are important for preventing specific colors you don’t want altered from being changed, as well as for saving changes to points that you’ve adjusted. All adjusted points become locked. The outer corners of the Chroma-Luma grid are locked, as is the outer ring and center point of the Hue-Saturation web.
White control points are neither selected nor locked, and will be stretched or squished when adjacent control points are moved.

While control points work much the same in either the Hue-Saturation or Chroma-Luma modes, there are some important differences. The radial "spokes" of the Hue-Saturation wheel don’t influence neighboring spokes, so any adjustment you make to a control point on one spoke only affects the colors that fall between it and the two neighboring spokes that surround it. This means it’s not necessary to lock control points on neighboring spokes of this wheel-shaped grid to prevent them from changing.

Both the Hue-Saturation and Chroma-Luma warper grids lock the outer boundary of the grid. You can still drag these points to adjust them, but they can’t be unlocked and they won’t move automatically when you adjust other control points. The Hue-Saturation grid has an additional point locked right in the center, which keeps the neutral colors (black through gray and white) neutral.

**TIP:** Dragging the locked center point of the Hue-Saturation grid lets you alter the color of the white point, while proportionally warping all other colors in the image to smoothly accommodate this change. This can be the starting point of a lot of different looks.
Previewing Which Colors Are Warped By Each Control Point

If you press and hold the Option key while you click on a control point in the warp grid, you get a preview in the Viewer of which colors that control point will affect. Affected pixels appear in color against black, which represents all pixels that will remain unaffected by that control point.

Holding the Option key down while clicking a Color Warper control point shows a preview of affected pixels against black.

Sampling to Warp Colors

While it’s important to learn how control points in the grid are manipulated, the most intuitive way of working with this control is to use the pointer to click within the Viewer to sample a color you want to adjust, hold the pointer button down, and then drag to adjust the color.

When moving the pointer in the Viewer, you’ll see a crosshairs moving around the warping grid that shows you the exact color on the vectorscope graph, while a yellow box indicates the control point that’s closest to the color you’re sampling that will be selected if you click. In the following example, positioning the eyedropper over the sky shows that clicking will select a control point close to the center of the grid.

Moving the pointer in the Viewer shows a preview in the warping grid of which control point you’ll select were you to click.

Clicking and dragging selects and then moves the control point corresponding to that color in the Viewer. As you drag the pointer, you’ll see the selected control point move in the same direction as the mouse while the colors of the image update in real time to show the adjustment you’re making. Meanwhile, an arrow in the grid shows you the delta of the current adjustment. Moving a selected control point to another hue in the grid warps the original color to the new color.
Clicking and dragging moves the control point corresponding to that color in the grid to adjust the color and locks it into place.

You can also lock control points by sampling the image. Hold the Command and Shift keys down, and then click on the color or colors you want to lock in the warp grid to prevent them from being changed. This makes it easy to work directly in the Viewer to lock colors you don’t want to change, before adjusting other colors that you do want to change.

In the following example, Command-Shift-clicking on the woman’s shoulder locks the yellowish highlights falling on her uniform in place. Then, clicking and dragging a highlight on her face lets us push the highlights towards teal without losing the warmer highlights on her shoulder, all by sampling directly in the Viewer.

**Resetting Grid Points**

If, at any point, you adjust a point that you want to reset, simply right-click on that point to de-lock and reset it.
Grid Resolution Affects The Specificity and Quality of Adjustments

You can change the resolution of the grids in either Hue-Saturation or Chroma-Luma modes, using the controls at the bottom of the Color Warper palette, underneath the grid itself. Separate drop-down menus let you choose the resolution of control points for hue and saturation, or for chroma and luma separately, although by default they're linked together.

The two resolution controls found underneath the grid controls

By default, the Hue-Saturation grid has a resolution of 6x6, which is the lowest resolution available. The Chroma-Luma grid defaults to 6x6, but can be set lower, to 4x4. Low resolution warping grids make it easy to create broad color adjustments affecting large ranges of analogous color with smooth results. Additionally, lower quality media that’s 8-bit, with 4:2:0 chroma subsampling, and/or highly compressed benefits from lower resolution warping grids to avoid artifacts and keep color adjustments smooth.

On the other hand, higher resolution grids let you make more specific adjustments to tighter ranges of color. However, this approach is more useful in projects using high quality media (10- or 12-bit, 4:2:2 or 4:4:4 chroma subsampling, and minimally compressed) to avoid unwanted artifacts. If you’re using high-quality media, you’ll find you can use the Color Warper to make incredibly specific adjustments.
NOTE: If you make adjustments with the grid at one resolution, it’s possible to change the
grid to a higher or lower resolution, and your adjustment will be interpolated to fit the new
grid resolution, although the resulting adjustment may change a bit.

You Can Warp Color in Different Color Spaces

A drop-down menu at the bottom right of the warping grid lets you choose which color space to use
for manipulating the colors of the image. Different color spaces project the colors of the image into the
two-dimensional warping grid in different ways, and some may make it easier to manipulate a
particular image in the way you want by spreading out different ranges of color more widely.

The available color spaces are:

- HSV
- HSL
- HSY
- HSP

Hue – Saturation Controls

As the name implies, the Hue-Saturation mode lets you alter hue and saturation simultaneously.
For most people, this is likely the most intuitive mode in which to work as the range of hues and
saturation in the image is represented radially, just like the Vectorscope; in fact a Vectorscope graph of
the image appears underneath the “wheel” grid of control points used to manipulate color.

By default, dragging any point of this grid changes the colors immediately surrounding that point that
are between the point being manipulated and adjacent “spokes” of the radial grid that either aren’t
influenced by that point, or are locked into place. In fact, you can pull these radial control points well
past the boundary of adjacent spokes of the grid to warp those colors to entirely different hues.
The selected control point being adjusted doesn’t affect points on adjacent columns of control points that stretch from the outer ring to the center of this control, even when the dragged point is moved all the way past.

When manipulating control points to alter color, adjustments are similar to pushing color around a color wheel. Moving a control point radially around the circumference of the grid changes the hue of the colors corresponding to that control point. Moving a control point closer to the center desaturates those colors, while moving a control point closer to the edge of the grid increases the saturation of those colors.

The following sections describe how the different tools available in this mode work to let you manipulate these radial control points in different ways.

Tools

Each of the available tools let you manipulate control points on the warping grid in different ways when you click on them.

- **Selection Tool**: The default tool mode. Selecting this tool lets you select control points either individually (by clicking on a single point or command-clicking multiple points) or collectively by dragging a bounding box over multiple points, and you can right-click on control points to de-select, unlock, and reset them. You can also Shift-click with this tool to lock points into place without moving them. This is the most useful tool to use when manipulating the image by clicking and dragging in the Viewer to sample a color and adjust it at the same time.

- **Draw Selection**: Selecting this tool lets you make a selection of control points by clicking and dragging to draw over all the points you want to select. This is good for making large, but specific, selections of points.

- **Pin/De-Pin**: Selecting this tool lets you pin multiple control points by either clicking on them or by clicking and dragging to draw over all the points you want to pin/de-pin.

- **Pull Points**: Selecting this tool lets you make adjustments by clicking anywhere on the warp grid, even between points, to pull all neighboring control points towards where you clicked. This can be used to reduce color contrast within a specific range of colors.

- **Push Points**: Selecting this tool lets you make adjustments by clicking anywhere on the warp grid, even between points, to push all neighboring control points within a particular proximity away from where you clicked. This can be used to increase color contrast within a specific range of colors.
Modifiers

Each of the Modifier buttons let you manipulate selections and selected control points on the warping grid in different ways immediately upon clicking each button.

- **Increase Falloff/Smooth Selection**: If you’ve selected one or more control points, clicking this button expands the selection to include all adjacent control points surrounding the selection.

- **Decrease Falloff/Smooth Selection**: If you’ve selected a group of control points, clicking this button shrinks the selection by deselecting the outermost ring of selected control points, leaving the inner control points selected.

- **Invert Selection**: Clicking this button selects all unselected control points, and de-selects all selected control points. This is useful when you want to make separate color adjustments to both specifically selected halves of the warping grid.

- **Convert Selection to Pin**: Clicking this button pins all currently selected control points.

- **Select/Pin Column**: If you have one or more control points selected, clicking this button expands the selection to include all points on every column that have at least one selected point.

- **Select/Pin Ring**: If you have one or more control points selected, clicking this button expands the selection to include all points on every ring around the center that have at least one selected point.

- **Select/Pin All, Deselect/Pin All**: Clicking this button toggles the selected state of the entire warping grid on or off.

- **Reset Selection/Pins**: If you have one or more control points selected, clicking this button resets their position to the original default position in the warping grid, without de-selecting them.

Range

The Range control is a fast method of selecting multiple control points corresponding to a specific range of colors.

- **Range**: A gradient shows the range of hues currently being presented in the warping grid. Dragging the left and right handles of the Range control selection box lets you automatically select all control points corresponding to the hues that appear within the selection box. This is a fast way of selecting all points within a range of colors for uniform manipulation.

Auto Lock Controls

The Auto Lock controls enables DaVinci Resolve to automatically lock a border of control points surrounding any control point you select and adjust, which makes highly-specific color adjustments easier to accomplish.

- **Auto Lock**: Enables and disables this behavior.

- **X Points Border**: Lets you set how many points away from the control point you’re adjusting the border of locked control points that restricts your adjustments is. How large an area this ends up being depends on how many points you choose, and on the resolution of the warping grid. At higher grid resolutions, the same points distance isolates a smaller region of color.

Smoothing Controls

The smoothing controls let you “ease off” an adjustment you’ve made by progressively moving one or more selected control points towards their original default position in the warping grid.

- **Smooth Chroma**: Each click of this button rotates the angle of selected control points around the circumference of the circular warping grid towards their original position, bringing the hue of the adjusted colors closer and closer to the original hues of the image. Saturation is unaffected.
– **Reset Chroma**: Resets the angle of all selected control points to the original hues of those control points. Saturation adjustments are unaffected.

– **Smooth Saturation**: Each click of this button moves the position of a control point closer to its original position relative to the center of the circular warping grid, thus bringing the saturation at that point closer to the original image saturation of the node’s input. Hue is unaffected.

– **Reset Saturation**: Resets the distance from the center of all selected control points to the original image saturation at those control points.

– **Reset Luma**: Resets luma to the original image values.

## Chroma – Luma Controls

The Chroma-Luma mode lets you alter the hue and lightness of colors in the image simultaneously. This may not feel like a particularly intuitive way of working, as the grid controls are overlaid on colors projected as different sides of an RGB cube. However, this enables some powerful adjustments once you get the hang of how multiple adjustments interact in this mode, as well as the power of locking control points to limit your adjustments to specific areas of the two grids.

Whether you’re sampling the image or manipulating the control points of this grid directly, dragging any point of this grid changes the color of the image corresponding to that point. Vertical adjustments change lightness, where up makes that part of the image lighter, and down makes that part of the image darker. Horizontal adjustments change hue, depending on which range of hues are shown in the two Chroma-Luma warping controls, and which of these you’re adjusting.

By default, only the outer four corners of this control are locked, so any adjustment you make to any control point pushes and pulls all the other colors throughout the image, depending on your adjustment. Working this way, multiple adjustments to multiple colors gradually pins different colors into place, with each adjustment warping the colors falling in between to maintain a smooth transformation from one adjustment to the next. This can be a good way to make an overall stylistic adjustment to the image.

(Top) The original image, (Bottom) The result of making multiple interacting color adjustments across the entire Chroma Luma grid
Another approach to using this mode is to make more targeted corrections by manually locking different colors in the image that you don’t want to adjust. You can do this by using the Selection tool and Shift-clicking any value in the Viewer, or by Shift-clicking any control point on the grid control. By locking colors you don’t want to change, you can focus on manipulating a more specific range of colors without altering the entire image.

Alternately, this is where the Auto Lock controls really shine. When you turn these on, you can choose the type of region you want to affect (vertical column, horizontal row, or a square region), then choose how large a region of color you want to manipulate (one or two points away from the point that’s selected). Keep in mind that the current resolution of the warping grid also has an effect on how large the resulting region of color will be. Lower resolution grids will let you manipulate larger regions of color, while higher resolution grids will let you adjust a more narrow range of color.

The Auto Lock controls let you make highly targeted adjustments to specific sections of the warping grid.

Once these controls are enabled, simply clicking once on the image or warping grid selects a control point and automatically locks off the region of the grid you want to focus your adjustment on. In the following example, a medium-resolution grid is used in conjunction with the Auto Lock controls set to lock a 2-point rectangular region. So, clicking on the skin of the woman’s face and dragging adjusts a section of available reds within the locked-off region of the grid.

Making a targeted color adjustment to a locked-off region of the Chroma Luma grid

The following sections describe how the different tools available in this mode work to let you manipulate these radial control points in different ways.

**Axis Angle**

When you’re in Chroma-Luma mode, an additional control appears underneath the warping grids, a slider named Axis Angle. Dragging this slider to the left or right changes the range of hues in each of the two warping grids that’s presented, letting you manipulate different ranges of color.

**Tools**

Each of the available tools let you manipulate control points on the warping grid in different ways when you click on them.
– **Grid 1/Grid 2 tabs:** Since the Chroma-Luma controls expose two grids representing two different ranges of hue and luma, these two tabs let you choose which grid will be manipulated when you sample the image in the Viewer, as well as which grid the Tools controls affect.

– **Selection Tool:** The default tool mode. Selecting this tool lets you select control points either individually (by clicking on a single point or command-clicking multiple points) or collectively by dragging a bounding box over multiple points. You can also Shift-click with this tool to lock points into place without moving them, and you can right-click on control points to de-select, unlock, and reset them. This is the most useful tool to use when manipulating the image by clicking and dragging in the Viewer to sample a color and adjust it at the same time.

– **Draw Selection:** Selecting this tool lets you make a selection of control points by clicking and dragging to draw over all the points you want to select. This is good for making large, but specific, selections of points.

– **Pin/De-Pin:** Selecting this tool lets you pin multiple control points by either clicking on them or by clicking and dragging to draw over all the points you want to pin/de-pin.

– **Pull Points:** Selecting this tool lets you make adjustments by clicking anywhere on the warp grid, even between points, to pull all neighboring control points towards where you clicked. This can be used to reduce color contrast within a specific range of colors.

– **Push Points:** Selecting this tool lets you make adjustments by clicking anywhere on the warp grid, even between points, to push all neighboring control points within a particular proximity away from where you clicked. This can be used to increase color contrast within a specific range of colors.

### Modifiers

Each of the Modifier buttons let you manipulate selections and selected control points on the warping grid in different ways immediately upon clicking each button.

![The Modifier buttons](image)

– **Increase Falloff/Smooth Selection:** If you’ve selected one or more control points, clicking this button expands the selection to include all adjacent control points surrounding the selection.

– **Decrease Falloff/Smooth Selection:** If you’ve selected a group of control points, clicking this button shrinks the selection by deselecting the outermost ring of selected control points, leaving the inner control points selected.

– **Invert Selection:** Clicking this button selects all unselected control points, and de-selects all selected control points. This is useful when you want to make separate color adjustments to both specifically selected halves of the warping grid.

– **Convert Selection to Pin:** Clicking this button pins all currently selected control points.

– **Select/Pin Column:** If you have one or more control points selected, clicking this button expands the selection to include all points on every column that have at least one selected point.

– **Select/Pin Row:** If you have one or more control points selected, clicking this button expands the selection to include all points on every row that have at least one selected point.

– **Select/Pin All, Deselect/Pin All:** Clicking this button toggles the selected state of the entire warping grid on or off.

– **Reset Selection/Pins:** If you have one or more control points selected, clicking this button resets their position to the original default position in the warping grid, without de-selecting them.
Range
The Range control is a fast method of selecting multiple control points corresponding to a specific
range of colors.

![Range Control](image)

- **Range**: A gradient shows the range of hues currently being presented in the warping grid.
  Dragging the left and right handles of the Range control selection box, or dragging within the
  range control to set both boundaries, lets you automatically select all control points corresponding
to the hues that appear within the selection box. Once you’ve set a range, you can move the
range to the left and right by dragging the center of the selection. This is a fast way of selecting all
control points within a range of colors for uniform manipulation.

Auto Lock Controls
The Auto Lock controls enables DaVinci Resolve to automatically lock a border of control points
surrounding any control point you select and adjust, which makes highly specific color adjustments
easier to accomplish. These are particularly useful in the Chroma-Luma warping grid.

![Auto Lock Controls](image)

- **Auto Lock**: Enables and disables this behavior.
- **X Points Border**: Lets you set how many points away from the control point you’re adjusting the
  border of locked control points that restricts your adjustments is. How large an area this ends up
  being depends on how many points you choose, and on the resolution of the warping grid. At
  higher grid resolutions, the same points distance isolates a smaller region of color.
- **Lock Column**: Lets you choose to restrict your adjustment to affect all control points within a
  particular column of the rectangular Chroma-Luma graph. The width of this column is defined by
  the border width controls. This is useful when you want to primarily adjust the lightness of a range
  of colors, while making a small adjustment to hues.
- **Lock Row**: Lets you choose to restrict your adjustment to affect all control points within a particular
  row of the rectangular Chroma-Luma graph. The height of this row is defined by the border width
  controls above. This is useful when you want to primarily adjust the hue of a range of colors, while
  making a small adjustment to lightness.
- **Lock Region**: Lets you choose to restrict your adjustment to affect all control points within a
  rectangular region surrounding the selected point. The is useful when you want to adjust a
  targeted region of color that corresponds to a well-defined feature of the image, such as a
  specifically colored hat, shirt, foliage, or skin tone. Smaller regions will make more specific
  adjustments than larger regions.
Smoothing Controls

If you’ve found that you’ve gone a bit too far with an adjustment and need to back off a little bit, the Smooth controls let you do so gradually, or start over if necessary.

- **Smooth Chroma**: Each click of this button moves selected control points left or right, back towards their original position, bringing the hue of the adjusted colors closer and closer to the original hues of the image. Luma is unaffected.

- **Reset Chroma**: Resets the position of all selected control points to the original hues of those control points. Luma adjustments are unaffected.

- **Smooth Luma**: Each click of this button moves selected control points up or down, back towards their original position, bringing the luma of the adjusted colors closer and closer to the original luma of the image. Chroma is unaffected.

- **Reset Luma**: Resets the position of all selected control points to the original luma of those control points. Chroma adjustments are unaffected.
Chapter 134

Secondary Qualifiers

Secondary correction describes isolating a specific part of the image, or a specific subject, using a key. Keys in DaVinci Resolve are grayscale images that define which areas of the picture you want to alter (in white) and which parts of the picture you want to leave alone (in black). Keys can be generated either using the controls in the Qualifier palette, by using a Power Window, or by importing an external matte (for more information on how to use external mattes, see Chapter 143, “Combining Keys and Using Mattes”). This chapter focuses on how you can use qualifiers to key a range of color values (similarly to doing a green screen key) in order to create a matte with which to do this kind of isolated adjustment.

Contents

Secondary Qualifiers 2663
Adding a Secondary Operation to the Node Editor 2664
The Qualifier Interfaces 2664
Which Qualifier Do I Use? 2665
Basic Qualification Using the 3D Keyer 2666
Basic Qualification Using the HSL Keyer 2670
HSL Qualifier Presets 2673
Using Highlight to See What You’re Isolating 2673
Using Highlight to Solo Nodes 2674
Showing Picker RGB Values 2675
Qualifier Parameters 2675
HSL Qualification Controls 2675
RGB Qualification Controls 2677
Luma Qualification Controls 2678
3D Keyer Controls 2678
Secondary Qualifiers

This section covers the use of the Qualifier palette, which lets you pull a 3D, HSL, RGB, or Luma key, with which to isolate the correction you need. The Qualifier controls are fast and flexible when you need to isolate an irregularly shaped subject with a distinct range of color or lightness. Since you’re generating a key by sampling the image, there’s no need for tracking or keyframing, so in the right situation qualifiers can be your fastest solution. In the following example, the client likes the slightly cool treatment overall, but wishes that the skin tones were a little more vibrant. This is exactly the sort of situation where qualifiers can help out. Adding a second node, and using the 3D or HSL Qualifier to isolate the face makes it relatively simple to add color exactly where you want it.

Adding a second node and using HSL Qualification to isolate the skin tones

The image with a simple primary correction (Top)  
The final adjusted image (Bottom)
Just about every control in the Color page can be limited using the Qualifier modes available in DaVinci Resolve. This makes the Qualifier palette a jack-of-all-trades tool with 101 uses. A few practical examples include keying a red element that’s too intense for broadcast, in order to darken it or desaturate it; keying a range of green foliage, so you can shift its hue to a more attractive color; keying an actor’s skin tone in a commercial, to apply some selective softening to it; or keying a range of sky, in which to add blue.

The Qualifier palette is color-space-aware when you’re using Resolve Color Management (RCM) or ACES. This enables Qualifiers to create high-quality keys as you would expect, no matter what the color space of the original media is, or what Timeline Color Space you’re using, for both SDR and HDR mastering. This makes Qualifier isolations easier, and a more consistent experience no matter what your workflow happens to be.

Adding a Secondary Operation to the Node Editor

Any node can be switched between functioning as a primary correction, where the adjustments you make affect the entire image, and a secondary correction, where you’re adjusting a specific element in the scene. The only difference is that nodes being used for secondary corrections are limited using a qualifier, Power Windows, or an external matte.

If you’re planning to add a secondary operation to the current grade, you’ll need to first add another node in the Node Editor. When pulling a key to qualify part of the image, it’s important to understand that you’ll be sampling the YRGB values being fed to that node from any previous nodes in the tree. That means that the state of the image being fed to a node you’re qualifying affects the key you’re pulling.

For example, if the image coming out of Node 1 is well saturated and has a neutral color balance with a wide range of colors, but the image coming out of Node 2 applies a low saturation, monochromatically orange color wash, you may find it more difficult to pull a detailed key from Node 2 than you would from Node 1.

Choosing your battles–the image coming out of Node 1 will be easier to key than the highly stylized image coming out of Node 2

This is important because you have the flexibility of determining from what image you want to try pulling a qualified key. By connecting the node that’s outputting the best YRGB image for the key you’re trying to create to the node you’re qualifying, you can control what you’re keying. For more information about choosing which node to use for setting up a qualifier, see Chapter 143, “Combining Keys and Using Mattes.”

The Qualifier Interfaces

The DaVinci Resolve Qualifier palette interface is straightforward. To the left, graphical controls above numeric parameters let you manually adjust what ranges of each color component contributes to the key you’re creating. To the right, Selection Range tools below let you define a key by sampling pixels of the image using the pointer, while below a set of Matte Finesse parameters let you alter the shape of the key that’s been pulled.
The default qualification mode is the HSL Qualifier, which uses three color components, hue, saturation, and luma, to define a key. However, you can also use the RGB or LUM (Luma) qualification modes to pull keys using other combinations of color components. The LUM qualifier mode, in particular, lets you make targeted adjustments to specific ranges of image lightness. This is a technique employed by many colorists to alter color temperature within a specific range of image highlights or shadows.

Alternately, you can use the 3D qualifier to quickly and easily pull well-refined keys by drawing lines to sample colors from the image that correspond to volumes of color within a three-dimensional gamut. While the underlying technology is sophisticated, all you have to do is to draw blue lines to sample colors you want to isolate, or red lines to sample colors you want to subtract from the isolation you’re creating, all of which automatically generate a high-quality key. Each line you draw adds a sample to the selection list; you can turn each sample off and on to evaluate its contribution to the resulting key, or delete samples that don’t make a positive contribution.

No matter which qualifier mode you use, the Matte Finesse controls make it easy to refine the resulting key to be even cleaner and more usable. In some instances, you can even take a marginal key that would otherwise be unusable, and squeeze it into something useful using the Clean Black, Clean White, and Blur Radius controls.

**Which Qualifier Do I Use?**

The Qualifier palette’s four modes offer you the flexibility to use the best keyer for the job when it comes to isolating a range of color or brightness values. In some cases, keys that are difficult to pull using some modes are easier to pull using others. Here’s a brief summary:
– **3D**: The 3D keyer is a good one to start with if you’re trying to isolate a range of color such as a blue shirt, a cyan sky, a performer’s skin tone, or the orange leaves of a tree in autumn. Its interface of drawing lines over the part of the image you want to isolate, coupled with its high quality and extreme specificity, make it a fast and accurate tool to use in a variety of circumstances. However, the 3D keyer always samples every color component of the image; it’s not useful when you want to isolate specific color components, such as luma only, or hue and saturation without luma. The 3D keyer’s greatest strength, the speed with which you can sample areas of the picture to include (or exclude) from the final key, is also occasionally a weakness with images where your initial samples aren’t giving you satisfactory results, because there aren’t many ways to fine tune the key as it’s being generated (although you can manipulate the result). On the other hand, for most images you would want to qualify, two or three samples is all you need, in conjunction with using the Matte Finesse controls to adjust the resulting key. If you need to do some compositing in the Color page, the 3D keyer also does an excellent job doing blue and green screen keying to create transparency, and has a built-in Despill control as well.

– **HSL**: In many instances, the HSL keyer is not as immediately accurate as the 3D keyer, and will include a broader portion of the image for any given sample. On the other hand, if the 3D keyer is not giving you satisfactory results for a particular shot, the HSL keyer can sometimes do a better job. Because of its interface, the HSL keyer makes it easier to “fine-tune” the range and softness of each individual color component that’s sampled, in order to improve the result. The HSL keyer also gives you the option of disabling color components that you don’t want to contribute to the final key, so that you can pull a saturation-only key, or a hue-only key, for instances where that may solve the issue at hand.

– **RGB**: The RGB keyer shares many of the limitations and advantages of the HSL keyer, but since you’re sampling and adjusting red, green, and blue color components, the specificity with which you can fine-tune the resulting key works much differently.

– **LUM**: The LUM keyer works specifically to isolate parts of the image based on image tonality, lightness, or darkness. This is the perfect tool when you’re trying to isolate highlights or shadows in the image, which let you solve a multitude of different creative and technical issues. The LUM keyer is identical to using the HSL keyer with the Hue and Saturation qualifier controls turned off.

The following two sections provide an overview of how to use the 3D and HSL keyer modes in DaVinci Resolve.

### Basic Qualification Using the 3D Keyer

The 3D Qualifier mode offers a fast, simple way of pulling a key to isolate a range of color in the image, by drawing lines over the parts of the image you want to key. Each line you draw over the image adds to or subtracts from the cloud of values you’re carving out of a three-dimensional representation of all available colors; you don’t see this representation, but this “under the hood” functionality is what gives the 3D keyer its name.

The 3D keyer is a general-purpose keyer, letting you isolate any color you like. However, the 3D keyer is not good at pulling luma-only keys. If you’re looking to isolate a range of luma values in the image, you should use the LUM mode.

**To use the 3D mode to isolate a subject in the Viewer:**

1. Open the Qualifier palette, choose 3D from the mode drop-down, and click the eyedropper.
2. Click and drag across the part of the image you want to isolate to draw a line. Lines that add to the key are colored blue.
Drawing a line to create a key using the 3D qualifier

3 To see the key you’re creating as you work, click the Highlight button in the Viewer Options toolbar at the top of the Viewer.

Viewing the key using the Highlight button

With the Highlight turned on, the lines you draw become invisible. They’ll reappear whenever you turn the Highlight off.

4 If necessary, draw additional lines to add more of the image to the key you’re creating. Ordinarily, it’s a good idea to not to draw more than two or three lines to sample the part of the image you’re trying to isolate. Ideally, you want the key you’re pulling to have a somewhat soft edge, which makes it easier to use the Matte Finesse controls to fine-tune your result later on. If you draw too many lines to sample the image, the result can be a key with hard, jagged edges that can sometimes be more difficult to adjust later on.
A hard-edged key created with three samples

5 Alternately, if there are parts of the image that are included in the key that you want to omit, hold the Option key down and draw a line over these areas. When you turn the Highlight button off, you can see that Option-drawn lines are red, and these subtract areas from the key you’re creating. Again, try not to overdo drawing subtractive red lines, as you can end up with an overly hard-edged key that’s difficult to adjust using other controls in the next few steps.

Blue lines add to the key and a red line subtracts the grass from the key, as seen with the highlight turned off

6 If you find yourself wondering whether a particular sample in the list at left is doing any good, you can click the color patch at the left of any entry in the list to toggle that sample off and on. If you decide you don’t need a particular sample, click the trash can button at the right to delete it.

Controls for toggling samples off and on, and deleting them from the list

7 When you’re satisfied that the key is good enough to start fine-tuning, stop drawing lines. It’s all right if there’s a bit of noise, speckling, or if there are small holes in the key you’re creating, because you can take care of these using the Matte Finesse controls.
Nearly every key you pull will benefit from some further "post-key" refinement. What this means is that, once you've created the best key you can procedurally through sampling the image, you can now adjust the resulting key itself, which is just a gray-scale image, to improve the isolated result. This is what the Matte Finesse controls are for.

Matte Finesse controls

8 The three most common methods of key refinement using the Matte Finesse controls are to increase Clean Black to fill in "holes" in the parts of the image you're omitting (the background), increase Clean White to close holes in the part of the image you're isolating (the foreground), and then use Blur Radius and In/Out Ratio controls to blur the edge of the key and push it in and out. Using these controls, you can vastly improve nearly any key without the need to endlessly readjust the Qualifier controls.

More information about using the Matte Finesse controls appears later in this chapter.

9 When you're finished, click the Highlight control to turn the highlight off, and make whatever adjustment you need. In this example, the orange of the helicopter will be adjusted using the Hue control to make it blue instead.
Basic Qualification Using the HSL Keyer

The HSL qualifier is one of the most flexible tools in DaVinci Resolve. Using any combination of sampled hue, saturation, and luma, you can isolate different ranges of color and contrast for specific adjustment. HSL is a general-purpose keyer, meaning you can key any color you like; it’s not restricted to blue or green.

The most straightforward way to use any qualifier is to sample the image in the Viewer. A set of four controls let you sample pixels within the image in different ways. When you sample one or more pixels, the Hue, Saturation, and Luma values are analyzed, and set different ranges in each of the Hue, Saturation, and Luma qualifier controls. There are a number of different eyedropper controls available to control how you sample color in the image.

- **Sample Eyedropper:** The first control you use whenever sampling the image. It defines the initial range of the qualification; you must use this tool before any of the others. Clicking once with this tool selects a single pixel value, while clicking and dragging selects a range of image values that add together.

![Color Picker button](image)

- **Add/Subtract Color Range:** These two controls let you add areas of the image to, or subtract them from, the currently selected inner range of values that define the core of the key. As with the eyedropper, you can click on single pixels, or drag over a range of color.

![Add and Subtract color buttons](image)

- **Add/Subtract Softness:** These two controls let you redefine the softness that transitions from the inner range of the key, falling off towards the outer edge of the key. Just like the other controls, you can click on single pixels, or drag over a range of color.

![Add and Subtract qualifier softness](image)

**NOTE:** When you select one of the sampling controls, it remains selected until you select another sampling control. If you select another clip in the Timeline, then click in the Viewer to sample a key and nothing happens, make sure that you select the Eyedropper control in the Qualifier palette.
If you’re working with the DaVinci Resolve onscreen interface, the easiest way to qualify a subject is to use the pointer in conjunction with the sampling controls.

Example image to qualify

To use the HSL Qualifier mode to isolate a subject in the Viewer:

1. Open the Qualifier palette, choose HSL from the mode drop-down, and click the eyedropper.

2. Either click a pixel of the part of the image you want to isolate, or click and drag across a range of pixels within that subject.

Picking to qualify the ocean

3. To see the key you’re creating as you work, click the Highlight button in the Viewer Options toolbar at the top of the Viewer.

By default, the area of the image you’re isolating appears in color, while the area of the image being excluded appears solid gray.

Viewer image with highlight turned on, isolated region appears in color, omitted region appears gray

Even though the highlight obscures the rest of the image, this doesn’t prevent you from using the sampling tools to select pixels you can’t see.

4. To subtract from the inner range of the key you’re creating, click the minus Color Range control, and click or drag across the portion of the keyed image that you’d like to exclude.

5. To add softness to the outer range of the key you’re creating, click the plus Softness control and then click or drag across the portion of the image you’d like to include as a soft edge.
Once you’ve finished using the range and softness sampling controls to refine the key you’re using to isolate the subject, nearly every key you pull will benefit from some further “post-key” refinement. What this means is that, once you’ve created the best key you can procedurally through sampling the image, you can now adjust the resulting key itself, which is just a grayscale image, to improve the isolated result. This is what the Matte Finesse controls are for.

6 The three most common methods of key refinement using the Matte Finesse controls are to increase Clean Black to fill in “holes” in the parts of the image you’re omitting (the background), increase Clean White to close holes in the part of the image you’re isolating (the foreground), and then use Blur Radius and In/Out Ratio controls to blur the edge of the key and push it in and out. Using these controls, you can vastly improve nearly any key without the need to endlessly readjust the Qualifier controls.

More information about using the Matte Finesse controls appears later in this chapter.

7 When you’re finished, click the Highlight control to turn the highlight off, and make whatever adjustment you need. In this example, the saturation has been raised and the color balance changed to make the adjustment obvious.
HSL Qualifier Presets

There is a set of HSL Qualifier presets, or Six Vector presets, that you can use to isolate automatically a predefined wedge of color (green, blue, red, magenta, yellow, or cyan) or chroma intensity (chroma light, chroma dark, or both). These presets are available either from the Color > Presets menu, or using the DaVinci Resolve Advanced control panel.

Selecting one of these presets automatically sets the HSL Qualifier to the corresponding range or color or lightness. Afterwards you can continue modifying the HSL Qualifier to suit your purpose.

Using Highlight to See What You’re Isolating

The Highlight control at the top of the Viewer (revealed by turning on Viewer Options in the Viewer’s Option menu) lets you overlay a representation of the key you’re creating over the current image in the Viewer. Overlays are also mirrored to your video output, so they’ll show up on an external display as well, in the event that you’re hiding the onscreen Viewer.

There are two types of highlights with which you can evaluate a qualification you’re creating. Each is useful for different tasks.

– **Flat-Gray**: The default highlight that DaVinci Resolve uses shows the selected portion of the image with the original colors, and the unselected portion of the image with a flat gray. It is useful for seeing the subject you’re isolating even while you’re adjusting the Qualifier controls, which lets you also see the color or contrast adjustments you’re applying at the same time.
High-Contrast: Pressing Option-Shift-H, you can show what’s called a “high-contrast” highlight, which should be familiar to you if you’ve used other color correction applications and plug-ins; it’s a more typical display wherein the selected portion of the image is white, and the unselected portion of the image is black. The high-contrast highlight is useful in situations where you need to eliminate holes in a key, or evaluate how “chattery” a key is since irregularities are easier to spot when divorced from the original image.

To enable or disable a highlight, do one of the following:
- In the Viewer Options toolbar at the top of the Viewer, click the Highlight control, and choose the type of highlight you want from the buttons that appear at the right.
- Choose an option from the View > Highlight submenu; a regular Highlight is Shift-H.

To enable or disable a high-contrast highlight, do one of the following:
- Choose View > Highlight > Highlight BW (Option-Shift-H).

To make high-contrast black and white the default highlight:
1. Open the Preferences > User > Color window.
2. Check “Mattes display high contrast black and white.”
3. Click Save.

The next time you click the Highlight control in the Qualifier palette, the high-contrast highlight will display.

Using Highlight to Solo Nodes
There’s one other use of the Highlight control, and that’s to solo individual nodes in the Viewer and video out, rather than outputting the sum of the entire node tree. For example, if you’re trying to adjust a stack of nodes attached to a Parallel or Layer Mixer node, it’s difficult to see what you’re doing while adjusting one of the stack of nodes, because only the final result is being output.

However, if you turn on Highlight while you’re selecting a node with no key, then only the currently selected node is output, making it easy to view just one node as you adjust it. Just make sure you turn Highlight off before moving on, or you may confuse yourself.
Showing Picker RGB Values

While you’re dragging the pointer over the Viewer and looking for a feature to sample, you can enable a tooltip that shows you the RGB Value of the pixel under the pointer by right-clicking the Viewer and choosing Show Picker RGB Value to toggle this feature on and off. When you turn this feature on, the View > Show RGB Picker Values In submenu has options for displaying either 8- or 10-bit tristimulus values.

Qualifier Parameters

Each of the Qualifier modes, except for the 3D qualifier, has parameters that correspond to the relevant color components for that mode, with which you can identify a range and softness, similar to using the sample tools. These parameters can be edited precisely with virtual sliders using the pointer, or using the knobs of a supported grading control panel. However, mouse and tablet users can take advantage of each qualifier’s draggable white overlays, for more direct adjustment.

– Drag the left and right edges of any qualifier control overlay to adjust the Low and High values (or the Width value of the Hue control).
– Drag the center of any qualifier control to change the center or to simultaneously change the Low and High parameters together.
– Option-drag the left and right edges of any qualifier overlay to adjust softness.

These draggable controls work for the HSL, RGB, and LUMA qualifier controls (the 3D qualifier works differently).

HSL Qualification Controls

The HSL Qualifier is by far the most versatile mode of the Qualifier palette. It’s also the qualifier that’s easiest to understand, and the easiest to adjust by hand if you don’t feel the need to sample the image. By selecting range and softness for each of three different color components, hue, saturation, and luma, you can isolate a wide variety of colorful subjects, or ranges of image lightness and saturation.
One of the HSL Qualifier’s key strengths, and one of its most underutilized features, is that you can enable or disable each of the three HSL components using the Hue, Sat, and Lum buttons, using toggle controls found at the left of each qualifier range control’s name. This lets you ignore specific color components, while focusing on others that are more important.

For example, if you’re trying to isolate the saturated parts of an image, regardless of the hue or brightness, you can turn off the Hue and Lum qualifiers so that only Sat is used to sample the image.

The HSL parameters include:

- **Hue Center**: Defines the center of the range of Hue being isolated.

- **Hue Width**: Defines the width of the range of hue being isolated. Widening or narrowing this parameter widens and narrows the range of hue about the current Hue Center.
– **Hue Soft**: Widens or narrows the falloff at both sides of the currently selected range of hue.

– **Hue Symmetry**: Lets you selectively alter the angle of Hue Soft falloff at either the right or left side. Lowering this parameter makes the softness to the right of the hue range grow steeper. Raising this parameter makes the softness to the left of the hue range grow steeper.

– **Sat Low/High**: Two parameters let you define the upper and lower range of saturation being isolated.

– **Sat Low Soft/High Soft**: Two parameters let you define the upper and lower softness falling off outside the current range of saturation.

– **Lum Low/High**: Two parameters let you define the upper and lower range of luma being isolated.

– **Lum Low Soft/High Soft**: Two parameters let you define the upper and lower softness falling off outside the current range of luma.

**RGB Qualification Controls**

The RGB Qualifier mode lets you isolate range and softness in the Red, Green, and Blue channels of an image. While this is not necessarily an intuitive way of manually creating a qualification from scratch, it can provide a different way of isolating potentially trickier ranges of the RGB color space.

If you start by sampling the image, then you can widen and narrow each color channel's isolated range of values. In some cases, you may find it’s faster to isolate a specific range of continuous color by adjusting these controls.

![RGB qualification controls](image)

**The RGB parameters include:**

– **Red Low/High**: Two parameters let you define the upper and lower range of the Red channel being isolated.

– **Red Low Soft/High Soft**: Two parameters let you define the upper and lower softness falling off outside the current range of red.

– **Blue Low/High**: Two parameters let you define the upper and lower range of the Blue channel being isolated.

– **Blue Low Soft/High Soft**: Two parameters let you define the upper and lower softness falling off outside the current range of blue.

– **Green Low/High**: Two parameters let you define the upper and lower range of the Green channel being isolated.

– **Green Low Soft/High Soft**: Two parameters let you define the upper and lower softness falling off outside the current range of green.
Luma Qualification Controls

The Luma Qualifier mode simply pulls a key from the Luma channel all by itself. It’s identical to the HSL qualifier with H and S turned off. This single-component keyer is more useful than you might think; it’s a common technique to isolate a range of highlights, midtones, or shadows throughout the image to alter the color temperature selectively.

The Luma Keyer mode automatically disables the Hue and Saturation controls

Also, keep in mind that the luma component is the sharpest keyable component when you’re working with heavily compressed video. Keys that are noisy or chunky with HSL qualification may be sharper if you just use the Luma Qualifier, although you won’t be able to be chromatically specific.

The Luma Qualifier has four parameters:

- **Lum Low/High**: Two parameters let you define the upper and lower range of the luma component being isolated.

- **Lum Low Soft/High Soft**: Two parameters let you define the upper and lower softness falling off outside the current range of luma.

3D Keyer Controls

As discussed earlier in this chapter, the 3D Keyer works much differently than the other qualifiers in DaVinci Resolve. In this mode, drawing lines over parts of the image you want to isolate adds samples to the Sample list, some of which add to the key (when you drag with the pointer) and some of which subtract from the key (when you Option-drag with the pointer). While this functionality is very simple to use, there are other controls that are available.
The 3D parameters include:

- **Show Paths**: A checkbox that lets you turn the visibility of the lines you’re drawing to sample the image on and off. Turning lines off does not affect the key in any way.

- **Colorspace**: A drop-down menu that lets you choose whether you’re sampling colors in YUV colorspace or HSL colorspace. YUV is the default, but if you find you’re not getting satisfactory results, you can reset the Qualifier palette and switch to HSL to see if that works any better.

- **Softness**: A single parameter lets you adjust the overall softness of the key you’re creating. The default value is 50. Raising this value increases key softness, lowering it decreases key softness.

- **Despill**: If you’re using the 3D keyer to pull a blue or green screen key to create transparency in conjunction with the optional Alpha output in the Node Editor, this checkbox lets you turn on an automatic color correction that eliminates blue or green spill from the image, while retaining the image’s original color.

- **Sample list**: A list shows each line you drew as a sampled entry. A color patch at the left shows you the average color you sampled, clicking the color patch lets you temporarily turn any color sample off to evaluate its contribution to the overall key. A plus or minus icon shows you whether that patch is adding to or subtracting from the key. The average red, green, and blue color values are shown next, and a trash can icon at the right lets you delete any sample from the list.

**Matte Finesse Controls**

After you’ve used the sample controls and qualifier parameters to create the most useful key for your purposes, you may find that it has problems that cannot be overcome easily by the available adjustments. Issues such as chattery edges, holes, or noisy bits can sometimes be easily fixed using the Matte Finesse controls. These controls filter the output of the Qualifier controls and are adjustments that are made to the matte itself, so they may work well in some instances, and poorly in others, depending on what you’re trying to do.

**Matte Finesse Controls, Page 1**

Denoise has been re-added to the Matte Finesse controls, providing a distinct way to post-process extracted keys to selectively reduce the noise in a key, getting rid of stray areas of qualification and softly filling “holes” in a matte.
**Denoise**

Denoise provides a distinct way to post-process extracted keys to selectively reduce the noise in a key, getting rid of stray areas of qualification and softly filling holes in a matte.

Before/after raising Denoise, viewing the high contrast matte

---

**Clean Black**

Clean Black is a specialized operation that eliminates noise (seen as white speckling when viewing a high-contrast highlight) in the black area of a key that omits the regions of the image you don’t want to isolate, and shrinks the key by making the dark parts of a key darker the higher you raise this parameter, pushing dark gray areas of the key toward black. The practical result is that raising Clean Black lets you “fill holes” in the background portion of a key and erode translucent edges.

Before/after raising Clean Black, viewing the high contrast matte

---

**Clean White**

Clean White is another specialized operation that eliminates noise (seen as black speckling when viewing a high-contrast highlight) in the white portion of a key that include areas of the image you’re isolating, and expands the key by making light parts of a key lighter the higher you raise this parameter, pushing light gray areas of the key toward white. The practical result is that raising Clean White lets you “fill holes” in the foreground portion of a key and grow translucent edges.

Before/after raising Clean White, viewing the high contrast matte
**Blur Radius**

In small amounts, blurring a key does well to take the edge off problem edges. However, blurring a key can also feather the edges of a key past the border of the subject you’re keying, with the result being a visible “halo” around your subject depending on the adjustment you’re making. The range is 0 to 2000, with 0 being the default. With such a large maximum blur radius, combined with the capabilities that the In/Out Ratio provides in customizing the direction of spread, you can turn some pretty precarious mattes into surprisingly smooth and useful results.

**TIP:** If haloing is a problem, you can try adjusting the In/Out Ratio parameter, or you may want to consider using the Qualifier Softness parameters to feather the edges of the key, instead.

---

**In/Out Ratio**

Controls whether the “Blur Radius” is applied equally to the inside and outside of the edge of the matte (zero), applied only within the matte (negative values), or applied only outside the matte (positive values). Using In/Out Ratio can help eliminate fringing when using the Blur Radius parameter.

However, you can also use In/Out Ratio even in situations where no Blur Radius is applied at all. Raising In/Out Ratio will fill in small black holes in the matte, while lowering In/Out Ratio below 0 will eliminate speckling by pushing small white bits of the matte toward black.
Matte Finesse Controls, Page 2

The second page of Matte Finesse controls expose controls for shrink, grow, opening, and closing functionality, with control over the shape of the operation, the radius, and iterations. The previously available Black Clip and White Clip controls have also been moved into this second page.

![Shrink/Grow controls in page 2 of the Matte Finesse controls](image)

Shrink/Grow/Opening/Closing

The Mode, Shape, Radius, and Iterations controls let you refine the edges of mattes in a variety of ways, shrinking and growing a matte with problem edges, or opening and closing holes that appear within a matte.

- **Mode**: Lets you choose how you want to modify the alpha channel/key. You can choose Shrink or Grow to dilate or erode the edges of the matte with great accuracy. Or, you can choose Opening or Closing to plug or expand holes to clean up a ragged matte.

- **Shape**: Lets you choose how corners and angles in the edges of the key are handled when you grow or shrink it. Circle is the default, and results in even expansion around the surface of the key that eventually averages all angles into a circular shape if you use extreme radius settings. Square averages all angles into a more rectangular shape if you use extreme radius settings. Diamond averages all angles into a diamond shape if you use extreme radius settings.

- **Radius**: Adjusts how much to shrink, grow, open, or close the key.

- **Iterations**: Alters the effect of the Operator Radius setting to create more extreme adjustments.

![Left] A matte with small holes in the face. (Right) Mode set to Shrink, Shape set to Circle, Radius set to 3, Iterations set to 3; used to close holes in a matte.
Black Clip
Raising Black Clip applies a "lift" adjustment such that translucent areas of the matte (gray areas when viewing a high-contrast highlight) are pushed towards black. The range is 0 to 100, with 0 being the default setting.

Before/after raising Black Clip

White Clip
Lowering White Clip applies a "gain" adjustment such that translucent areas of the matte (gray areas when viewing a high-contrast highlight) are pushed towards white. The range is 0 to 100, with 100 being the default setting.

Before/after lowering White Clip

The Many Ways to Invert a Key

Sometimes, you’ll need to isolate a subject or range of values in an image, and then make a change to everything else. One way to do this is to add an Outside node after the node in which you’ve created the key. This lets you make one set of adjustments to what you’ve keyed, and another set of adjustments to everything outside the key.

If you just need to make a simple adjustment, you can invert the key from within the Qualifier palette. However, there are three other ways to invert a key.

- **The Qualifier Invert button**: Clicking this control simply inverts the key being generated by all of the controls within the Qualifier palette.

- **Key Palette Qualifier Invert**: The Qualifier Invert control within the Key palette provides another control with which you can invert the key that’s generated by the Qualifier palette.

- **Key Palette Output Invert**: The Output Invert control within the Key palette is notable because it inverts the sum of all keys applied within that node. For example, if you’re using a Qualifier in conjunction with a Window, the two invert controls mentioned previously will only invert the Qualifier key; the Window key remains unaffected. However, using the Output Invert control inverts the overall combination of the Qualifier key and the Window, all together.
Combining Qualifiers and Windows

This is covered in more detail in a subsequent section, but if you create a key using one of the Qualifier modes, and you then add a Window, the final key that’s output by that node is limited to the intersection of the Qualifier key and the Window. This makes it easy to use a Window to “garbage matte” out bits of a key that you don’t want, that can’t be eliminated by further adjustment of the Qualifier controls.

(Top) The woman’s skin tone is too close to other elements in the scene.  
(Bottom) A Circular Power Window is used to further isolate the woman being isolated.

Manipulating Keys Using Additional Nodes

If you need to make more adjustments to a qualified key than the Matte Finesse controls will allow, you can use the Node Editor to feed the key output of one node to the RGB input of another, at which point you can use all of the second node’s color adjustment controls to manipulate the grayscale image that constitutes that key, to improve it.

Connecting a key output to an RGB input, and then connecting the RGB output back to the next node’s KEY input again
You can also use the Key Mixer node to combine multiple keys in several different ways, adding keys together, or subtracting them from one another, in order to create exactly the key you need.

For more information about these techniques, see Chapter 143, "Combining Keys and Using Mattes."
Secondary correction describes isolating a specific part of the image, or a specific subject, using a key. Keys in DaVinci Resolve are grayscale images that define which areas of the picture you want to alter (in white) and which parts of the picture you want to leave alone (in black). Keys are generated either using the controls in the Qualifier palette, by using a Power Window, or by importing an external matte (for more information on how to use external mattes, see Chapter 143, “Combining Keys and Using Mattes”). This chapter shows you how to use Power Windows to create shapes with which you can isolate parts of the image in different ways in order to do these kinds of targeted corrections.

Contents

- Power Windows 2687
- Adding Nodes with Windows 2688
- The Window Palette Interface 2689
- Managing Windows 2690
- Showing and Hiding Onscreen Window Controls 2690
- Using the High-Visibility Power Window Outline Option 2691
- Window Transform Controls 2691
- Window Softness 2693
- Drawing Curves 2694
- Converting Linear, Circular, and Polygon Windows into Bezier Curves 2695
- Resetting the Window Palette 2696
- Combining Power Windows with the Mask Control 2696
- Copying and Pasting Windows 2697
- Saving Window Presets 2698
- Using Windows and Qualifiers Together 2699
Power Windows

Power Windows are another way of making secondary correction, being essentially shapes you can use to isolate regions of the image. Different controls let you use oval, rectangular, polygonal, or custom curved shapes. Because you can isolate regions of the image by drawing, Power Windows produce exceptionally clean results, with edges that can be precisely positioned and feathered to achieve a variety of effects.

Before/after Curve Power Window isolates the sky area for a targeted correction.

Power Windows (also referred to as simply “windows”) are excellent when what you need to adjust can be encompassed within a clearly defined geometrical area. For example, the oval of a person’s face, the front of a car, or a wide expanse of sky are all good candidates for windowed adjustments. A drawback of windows can be that they must be animated to follow whatever subject they’re isolating. Fortunately, this is where DaVinci Resolve’s powerful tracker comes in, making it easy to track Power Windows quickly and accurately to follow along with the subject being isolated.

Circular Power Window to focus attention to the skin
DaVinci Resolve makes it easy to combine multiple Power Windows in different ways, to intersect with one another and create even more sophisticated shapes. For example, multiple windows can be added together, or one window can be used to cut out part of another window, which saves you from the need to make complicated keyframing operations to animate that window’s shape.

Adding Nodes with Windows

As with qualifiers, you must first add a node to a grade’s node tree before you begin windowing a correction. This is because all of the windows within a particular node work together to limit that node’s grade. As a reminder, any node can be changed from a primary operation that affects the entire image, to a more targeted secondary operation, simply by turning on a window, using a qualifier, or enabling an external matte.

If you don’t create a new node before creating a window, you’ll discover you’ve inappropriately changed a primary correction into a secondary correction. If you create a new serial node, you’ll then need to use the controls found within the Window palette to turn on a window to customize for your purposes. However, there are also a set of commands you can use to add serial nodes with a window already turned on, saving you a few clicks or button presses in the process.

To add a new node with a window already turned on:

- Choose Color > Nodes > Add Serial Node + CPW (Option-C) to create a new serial node with a circular window.
- Choose Color > Nodes > Add Serial Node + LPW (Option-Q) to create a new serial node with a linear window.
- Choose Color > Nodes > Add Serial Node + PPW (Option-G) to create a new serial node with a polygonal window.
- Choose Color > Nodes > Add Serial Node + PCW (Option-B) to create a new serial node with a Curve window.
When you add a node with a Power Window, the Window palette automatically opens up, ready for editing.

The Window palette

The Window palette is divided into three sets of controls: the Window list, the Presets, and the Transform and Softness controls.

The Window Palette Interface

Once you’ve created a node with which to apply a Power Window correction, you need to open the Window palette if it hasn’t been opened already.

To open the Window palette:

– Click the Window palette button.

The majority of the Window palette is occupied by the Window list, within which you can create as many windows as you need for the task at hand. There are five types of windows you can create, each of which has a different geometry. You can use these windows individually, or you can combine them to create even more complex shapes and interactions. The Window palette has four groups of controls that let you use these windows in different ways.

The Window palette with the Window list

– **Window list:** A row of buttons at the top of this list lets you add new windows, which you can then customize as necessary. Each window in the list exposes an On/Off button that shows the shape type, a Layer Name field (blank until you add some text) that you can use to identify what each window is for, an Invert button, and a Mask button that governs how that window interacts with the other windows that are currently enabled (adding to other windows by default, or subtracting from other windows in Mask mode).
Transform parameters: Controls the overall size, aspect ratio, position, and rotation of the currently selected window.

Softness parameters: Controls the edge softness of the currently selected window. Different window shapes have different softness options.

Option drop-down menu: The Option drop-down menu has commands for creating and modifying custom window presets for easy recall later, resetting windows, deleting windows, saving and managing window presets, and copying and pasting track data.

Using buttons along the top of the Window palette, there are five types of windows you can create:

- **Linear**: A four-point shape that can be edited into any kind of rectangle or trapezoid you might need. In addition to the center and corner controls, you can also drag any of the four sides to change the shape.

- **Circular**: An oval that can be shaped, sized, and feathered to solve an amazing number of problems.

- **Polygonal**: A four-point shape that can be expanded with additional control points to create complex sharp-cornered polygonal shapes.

- **Curve**: A Bezier drawing tool that you can use to create any kind of shape, curved, polygonal, or mixed, that you require.

- **Gradient**: A simple two-handled control for dividing the screen into two halves, with options for the center, angle, and feathering of the shape. Good for fast sky adjustments.

Managing Windows

To manipulate a window, first you need to create the type of window you want to use, or if you’ve got a group of windows created already, you need to select the window you want to work on.

Methods of creating and selecting windows:

- **To create a new window**: Click the Shape icon button or click the Create Window button (at the top of the Window list) that corresponds to the window you want to create.

- **To select a window using the onscreen controls**: Click anywhere within a window to select it in the Viewer.

- **To select a window from the Window list**: Click the Shape icon button corresponding to the window you want to select.

To delete a window you no longer want:

- Select a window, then click the Delete button.

To reset a window:

- **To reset one window to its default shape**: Select a window, then choose Reset Selected Window from the Option drop-down.

Showing and Hiding Onscreen Window Controls

When you open the Window palette, the Viewer goes into Power Window mode. Enabling a window makes that window's onscreen controls appear within the Viewer, and are mirrored to video out so you can see the window controls on your external display. If you like, you can change how and where the onscreen controls appear.
To choose whether onscreen controls are mirrored to video out, or disabled, do one of the following:

- Choose an option from the View > Window Outline submenu.

There are three options:

- **Off**: Hides the window outline on both the external display and the Viewer.
- **On**: The default, shows the window outline on both the external display and the Viewer.
- **Only UI**: Hides the window outline on your external display, but leaves it in the Viewer.

- Press Option-H to toggle among all three of the above modes.

This command is a three-way toggle. The first use of this command hides the window outline on your external display, but leaves it in the Viewer. The second use of this command hides the window outline on both the external display and Viewer. The third use of this command shows the window outline on both the external display and Viewer.

**TIP**: If you leave the onscreen controls visible in the Viewer, you may find that as you work you want to temporarily hide or show the onscreen controls in the Viewer so you can get an uncluttered look at the image you’re adjusting. You can quickly toggle any set of onscreen controls off and on without selecting Off in the menu by pressing Shift-` (tilde).

### Using the High-Visibility Power Window Outline Option

Ordinarily, Power Window outlines are white (for the center shape) and gray (for the softness shapes). However, sometimes this color scheme can be difficult to see, so the Color panel of the User Preferences has an option in the General Settings section called “High visibility Power Window outlines.” Turning this on sets Power Window outlines to be drawn as green (for the center shape) and yellow (for the softness shapes), to make these windows easier to see in certain circumstances.

(Left) Default window outlines, (Right) High Visibility window outlines enabled in the Color panel of the User Preferences

### Window Transform Controls

Windows have transform parameters that are similar to those found in the Sizing palette. These parameters let you alter the window, affecting all of its control points together.
Window transform controls

- **Size**: Scales the entire window up or down. 50.00 is the default size.
- **Aspect**: Alters the aspect ratio of the window. 50.00 is the default value, larger values make the window wider, and smaller values make the window taller.
- **Pan**: Repositions the window along the X axis. 50.00 is the default position, larger values move the window to the right, smaller values move the window to the left.
- **Tilt**: Repositions the window along the Y axis. 50.00 is the default position, larger values move the window up, smaller values move the window down.
- **Rotate**: The default value is 0. Increasing this parameter rotates the shape clockwise, decreasing this parameter rotates the shape counterclockwise.
- **Opacity**: Lets you vary the transparency of an individual window’s contribution to a node’s key.
- **Convergence**: When “Apply stereoscopic convergence to windows and effects” is enabled in the General Options of the Project Settings, this additional Transform parameter appears that lets you create properly aligned convergence for a window placed onto a stereoscopic 3D clip. For more information about working with Stereoscopic 3D projects, see Chapter 14, “Stereoscopic Workflows.”

The transform parameters also correspond to onscreen controls found in the Viewer, which can be manipulated directly using the pointer.

![Manipulating the window position on the Viewer](image)

While many of the onscreen controls correspond to parameters within the Window palette, some onscreen controls, such as the control points that govern reshaping linear, polygonal, and Curve windows, are only adjustable via the pointer.
Onscreen controls for window transforms:

- **To select any window:** Click on one of an arrangement of many windows to select it, making that window’s controls active.

- **To reposition any window:** Drag anywhere within the window’s onscreen control. Window position corresponds to the Window palette’s Pan and Tilt parameters. For a gradient window, drag the center control point.

- **To resize a circular window while locking its aspect ratio:** Drag one of the four blue corner points out to enlarge, or inwards to shrink. This corresponds to the Window palette’s Size parameter.

- **To squish or stretch a circular window, altering its aspect ratio:** Drag one of the blue top, bottom, left, or right control points. These adjustments correspond to the Window palette’s Aspect parameter.

- **To rotate a window:** Drag the top inner white rotate handle, in the middle of the window. For a gradient, drag the bottom arrow handle.

- **To alter window softness:** Drag any one of the magenta softness handles. Different window shapes have different sets of handles, which correspond to the Softness parameters.

- **To reshape a linear window:** Drag any of the white corner handles to corner pin the window, or drag one of the white top, bottom, or side handles to move an entire side segment of the window around.

- **To reshape a polygonal window:** Turning on a polygonal window reveals a simple white rectangle with four corner control points. Click anywhere on the surface of the rectangle to add additional control points with which to reshape the polygon, and drag any control point to alter its shape. Polygonal windows are limited to a maximum of 128 control points.

- **To change the size and aspect of a curve:** Shift-drag a bounding box around the control points you want to transform, and then adjust the corners of the box to resize the points while maintaining the aspect ratio of the shape, or adjust the top, bottom, left, or right points to squish or stretch the shape.

- **To remove control points from polygonal or Curve windows:** Middle-click the control point you want to remove.

**NOTE:** Removing a control point from a polygonal window that’s already been animated using the Keyframe Editor results in that point abruptly popping on and off at the keyframes creating the animation.

### Window Softness

Each type of window has different Softness parameters, depending on how adjustable that window is.

- **Circular:** A single parameter, Soft 1, lets you adjust the uniform softness of the oval’s edge.

- **Linear:** Four parameters, Soft 1–4, let you adjust the softness of each of the four sides of the linear window independently. Magenta softness control points on the top, bottom, left, and right let you adjust the softness of each side of the linear shape independently.

- **Polygon:** Two parameters, Inside Softness and Outside Softness, let you adjust the overall softness of a polygonal window. There are no onscreen softness control points.

- **Curve:** Two parameters, Inside Softness and Outside Softness, let you adjust the overall softness of a curve. Using the onscreen controls, you can adjust the magenta inside and outside softness control points independently, creating any softness shape you need.

- **Gradient:** A single parameter, Soft 1, lets you adjust the uniform softness of the gradient window’s edge.
Drawing Curves

The Curve window is the only window that doesn’t display any onscreen controls when it’s first turned on. Instead, you must click within the Viewer to add control points, drawing your own custom shape to isolate whatever region you want.

Curve window to isolate a car

**TIP:** Turning on the Viewer’s full-screen mode can make it easier to draw detailed shapes. You can also zoom into and out of the Viewer while you’re drawing, using either the scroll wheel of a mouse or by pressing Command-Plus or Command-Minus.

**To draw a curve:**

1. Turn on the Curve window style control.
2. Click anywhere in the Viewer to start adding control points and drawing the shape you need.
3. Click and drag to add and shape Bezier curves, or just click and release to add a hard angle.
4. To finish drawing and close the shape, click the first control point you created to create a corner, or click and drag on the first control point you created to create a Bezier curve.

Once you’ve drawn a curve, there are many ways of manipulating it.

**Simple methods of modifying a curve:**

- **To add points:** Click anywhere on a curve to add control points.
- **To reshape a curve:** Drag any control point to a new location. You can drag control points even while you’re drawing a new curve, selecting previously drawn points to move them, to adjust their spline handles, or to delete previously added points, without the need to finish the window first.
- **To move a curve:** Drag anywhere within or just outside a curve to move it.
- **To symmetrically alter a Bezier curve:** Drag any Bezier handle. The opposite handle automatically moves in the other direction.
- **To asymmetrically alter a Bezier curve:** Option-drag any Bezier handle. The opposite handle stays in place while you drag the current handle. Once you’ve created an asymmetric pair of Bezier handles, they move together as one if you simply drag a handle. You need to Option-drag to change the angle.
- **To change a curve into a corner:** Option-double-click any Bezier curve control point to change it to a sharp-angled corner point.
- **To change a corner into a curve:** Option-click any corner point and drag to pull out a Bezier handle, changing it to a curve.
- **To remove points:** Middle-click the control point you want to remove.
NOTE: Removing a control point from a polygonal window that’s already been animated using the Keyframe Editor results in that point abruptly popping on and off at the keyframes creating the animation.

You can also Shift-drag a bounding box to select multiple control points on a curve to move, delete, or transform them all at once.

To select multiple control points on a curve:

1. Hold the Shift key down and drag a bounding box around the control points you want to manipulate or delete. All included control points will become highlighted.

2. Do one of the following:
   - To move the control points: Drag anywhere within the bounding box.
   - To transform the control points: Drag one of the outer corners to resize all control points symmetrically, drag the top, bottom, or side handles to squash or stretch the control points relative to one another, or move the pointer to one of the corners until the rotate cursor appears, and then drag to rotate the control points.
   - To delete the control points: Press the Backspace key.

3. When you’re finished, press the Escape key to deselect the control points.

Converting Linear, Circular, and Polygon Windows into Bezier Curves

If you start out isolating a subject using one of the simple Linear, Circular, or Polygon shape windows and you realize that you need a more complex shape to accomplish the task at hand, you can easily convert them to a more complex Bezier curve by choosing Convert to Bezier from the Window palette Option menu.
Once you’ve converted a simple shape to a Bezier window, you can add control points and manipulate the shape in any way you need to make it better conform to the subject, just as you would with any curve.

**Resetting the Window Palette**

The entire Window palette can be reset using the Option menu’s Reset command.

**Combining Power Windows with the Mask Control**

Adding multiple windows to a single node is an easy way to create composite keys. When combining windows, the Mask control defines whether one window adds to another window, or subtracts from that window.

In the following example, Circular and Curve windows have both been created, and each window’s Mask control is also turned on (by default), resulting in both masks being added together so that the sunset look correction affects both the sky and the woman’s face.

The two images show the combination of the key mattes.

By turning the Mask control of the circular window off, the circular window is subtracted from the curve.

Turning off the Mask control of the circular window

Now, the woman’s face is being protected from the aggressive sky treatment.
Since windows can be individually tracked and keyframed, you can quickly set up complex interactions of windows to solve common problems you'll encounter. For example, when you're tracking a window to follow a moving subject that moves behind something in the frame, you can use a second window with Mask turned off to cover the object in front. Now, when the tracked window intersects the subtractive window, the correction will disappear along with the subject.

You can also use the Mask control to create more complex shapes than you can with a single window.

Furthermore, once you reach the limits of what shapes you can create using the four available windows, you can combine multiple nodes containing multiple shapes and qualifiers using the Key Mixer.

### Copying and Pasting Windows

If there's a particular window you've created that you want to either duplicate within the current node, or apply to another node, you can copy and paste an individual window's shape from one item in the Window list to another.

**Methods of copying and pasting windows:**

- **To copy a window:** Click any enabled window in the Window list, then click the Window palette option menu and choose Copy Window.

- **To duplicate a window:** After copying a window, create another window of the same type that you copied, and then click the Window palette option menu and choose Paste Window.

- **To paste a window to another node:** Double-click or otherwise select another node, open the Window palette, choose the same type of window that you copied in the Window list, and then click the Window palette option menu and choose Paste Window.

- **To paste a window to the same node:** Click any enabled window in the Window list, then click the Window palette option menu and choose Copy Window, then click Paste Append Window in the Window Option menu.
Saving Window Presets

If you find there’s a particular window shape or combination of windows that you use frequently, you can save one or more windows as a preset for easy recall whenever needed. For example, if you’re working on a documentary within which you find you need to do a lot of face brightening, you can create preset face ovals for close-up, medium, and wide shots, to save you from having to customize a stock circular window for every single new shot. You can also save groups of windows together as a single preset, in order to reuse complicated multi-window shapes.

Window presets are available from a group of Presets controls in the option menu in the upper right-hand corner of the Window palette.

![Image of Presets controls]

Controls for saving, applying, and deleting window presets

Methods of working with Power Window presets:

- **To save a window preset:** Once you’ve created one or more windows you want to save, click the Save as New Preset option in the Window palette’s option menu. Type a name into the resulting dialog, and click OK. That preset is now available in the Preset section of the option menu.

- **To recall a window preset:** Click to open the Window palette’s option menu, and choose a preset from the list. Loaded window presets overwrite whatever other windows were set up in that node.

- **To update an already saved preset:** Recall a preset, change the resulting window(s), then click to open the Window palette’s option menu. Select Update Preset, then select the preset name. This will overwrite the selected preset with the altered window arrangement.

- **To delete a window preset:** Click to open the Window palette’s option menu, and choose Delete Preset, then choose a preset from the list. Make sure you chose the correct preset name; there is no warning before the deletion, and you cannot undo the deletion once it’s done.

Once recalled, windows created by presets can be modified and tracked just like any other window.
Using Windows and Qualifiers Together

Another use of windows is to act as a “garbage matte” when used together with a qualifier. By default, when you use a window and qualifier together, a key is only output where both the window and qualifier intersect. This makes it easy to exclude unwanted parts of a key that are too difficult to eliminate by further refinement of the qualifier controls.

For example, the following qualification is intended to isolate the woman’s face, but some of the similarly colored wood and sky in the background is also included.

Instead of driving yourself crazy trying to eliminate the unwanted parts of the key by modifying the current qualification, which is doing a great job of isolating the skin tones, you could instead use a window to isolate her face, excluding everything outside the window, and simplifying your job considerably.

If she moves, then you can simply track the window to follow. Simple tracking is covered in Chapter 137, “Motion Tracking Windows.”

Furthermore, you can use the window’s invert control to do the reverse, excluding all qualified portions of the key inside the window, and including all qualified portions of the key outside the window.

If you need to build more complex qualifier/window combinations than this, you can add more windows, or you can use multiple qualifiers and windows with the Key Mixer node, which is discussed in Chapter 143, “Combining Keys and Using Mattes.”
The Magic Mask palette uses the DaVinci Neural Engine, guided by the user via a stroke-based interface, to automatically create detailed masks with which to isolate humans, either whole or in part, to which you want to make secondary adjustments in DaVinci Resolve. This chapter describes how to guide these powerful features using the stroke and tracking controls found within this palette.

Contents

**Magic Mask** (Studio Version Only) 2701
What Magic Mask Is Good For, and What It’s Not 2703
The Magic Mask Interface 2704
Magic Mask Toolbar 2704
Stroke List 2705
Mask Adjustment Controls and Matte Finesse 2706
Choosing What to Isolate 2707
Person Mode 2707
Features Mode 2707
Identifying More Than One Person 2708
Using Matte Finesse Controls 2708
Using Magic Mask as a Garbage Matte 2709
Dealing With Hair 2709
About Hats 2710
Dealing With Accessories 2710
Adding Strokes to Guide Mask Creation 2711
Managing Strokes in the Stroke List 2713
Stroke Duration 2714
Tracking and Keyframing Strokes to Follow Subject Motion 2714
Methods of Moving Strokes to Follow Subject Motion 2714
Option Menu Commands for Removing Strokes and Tracking 2715
An Example Stroke Tracking Workflow 2716
Magic Mask (Studio Version Only)

The Magic Mask palette uses the DaVinci Neural Engine to automagically create a mask to isolate one or more people in the frame, guided by user-applied paint strokes to identify the subject for isolation. Masks can be generated for either an entire person, or for specific features of that person (their face, hair, arms, shoes, etc.). The following images show these two kinds of masks with Highlight enabled in the Viewer. A red onionskin overlay lets you see what Magic Mask is isolating.

(Left) Using Magic Mask to isolate an entire person, (Right) Using Magic Mask to isolate someone’s face

Once the Magic Mask palette has generated a mask, Matte Finesse controls let you adjust the mask’s size and feathering. This lets you deal with difficult edges that might tip your hand depending on the kind of adjustment you’re trying to make.

While the masks generated by Magic Mask can often be good enough to use directly for making high quality isolated adjustments, it won’t always give perfect results. Keep in mind that Magic Mask is as much for the fast creation of detailed garbage masks as it is for doing direct isolation.

In these cases, the Matte Finesse controls let you make the resulting mask softer and looser as necessary to clear the edge of a difficult subject you’re isolating with the help of another mask generation technique, such as a Qualifier key or window. When you use the Magic Mask palette within the same node in which you’re also creating a key in the Secondary palette, or a window in the Window palette, the key or window and Magic Mask are combined to output a boolean intersection. This means the isolation is limited to areas where both kinds of masks overlap one another.

(Left) Using Magic Mask to create a mask, (Right) Combining the Magic Mask with a circular window, the resulting mask is an intersection of the two

If you’re isolating specific features of a person, you can also mix and match what you’re isolating to create exactly the type of mask you require. For example, you might isolate the face, along with exposed skin on the torso, arms, and legs, to create a mask for creating an overall skin tone adjustment that doesn’t include the subject’s hair or clothes.
As described earlier, this whole process is guided by strokes you draw to identify the subject. In a typical workflow, you'll draw short positive strokes (colored blue) over the person or feature you want to isolate. Then, if necessary, you can also paint short subtractive strokes (colored red) over parts of the image that are not the person or feature you’re isolating, to correct any problems you see in the generated mask.

Blue strokes identify a person or feature to isolate, while red strokes identify things that shouldn’t be included in the mask.

Ideally, both positive and subtractive guidance strokes should be relatively short, and centered on the part of the person you're trying to add to the mask. Stroke position is usually more important than stroke length, and in fact if you don't like the result you're getting in the mask with a particular stroke you've drawn, you can drag it to another position without redrawing it; strokes are live and can be selected using the pointer to move or delete them.

Selecting a stroke with the pointer; selected strokes become highlighted.

Very long paint strokes aren’t usually that useful, and can be counterproductive later on when you’re trying to track strokes to follow motion in the clip. This is particularly true if a stroke needs to follow something that’s changing shape as it moves, like an arm. Furthermore, while you can make as many strokes as you like, fewer strokes work better than many strokes, and as a general rule you shouldn’t use more than five strokes to isolate a particular person or feature (nor should you need to).

As you work, each stroke shows up in the Stroke list, which lets you select, enable/disable, delete, and otherwise manage the different strokes you create to guide automatic mask generation.
But what about camera and/or subject motion, you ask? After you’ve painted one or more strokes to guide the analysis, you can motion track these strokes to follow the subject throughout that shot using the stroke tracking controls within this palette. If you’ve made multiple strokes, they’re all tracked at once, and each stroke automatically follows along with whatever image details immediately surround that stroke, so there’s no setup necessary. You simply draw one or more strokes, then click the track forward or backward button. When you track a stroke, the tracking bar for that stroke in the Stroke list shows you which frames have been tracked (tracked frames are blue).

Once you’ve added the strokes that are necessary to isolate the subject, and you’ve motion tracked them to follow along with the motion of the shot, a mask is automatically generated live for each frame of the shot. This is important to know because any change you make, adding or removing strokes or moving them manually, will alter the resulting mask on the fly.

**What Magic Mask Is Good For, and What It’s Not**

Keep in mind that the Magic Mask tool does not specialize in soft translucent mask edges, such as those created by the HSL, Luma, or 3D Keyers (when they’re used carefully). On the other hand, it excels at creating form-fitting masks that isolate human features in situations where a typical keyer does poorly. For example, Magic Mask can isolate exposed skin in shots where that person is standing in front of a background with wood, stone, or soil that inhabits the same ranges of color as that person. It can isolate beige clothes against a beige background. It can even isolate a person within a black and white clip.
Once you’ve drawn one or more strokes to isolate a mask, a variety of controls let you adjust the resulting mask to better fit the subject, if necessary. Depending on the adjustment you’re making to the subject at hand, you may find that the keys generated using Magic Mask are sufficient to convincingly isolate the person you’re grading, particularly if you’re working in Better mode.

However, real world projects pose plenty of unexpected challenges. Keep in mind that, depending on what you’re trying to do, the resulting automated mask isn’t always going to be perfect enough to replace precise rotoscoping for intensive secondary color adjustments. However, it’s been designed to easily create tight-fitting garbage masks to use in conjunction with secondary keys or windows, with which to exclude the background around a difficult-to-isolate subject.

If you’re using Magic Mask to create a garbage mask, keep in mind that the Faster mode has been optimized to create looser masks more quickly for situations where you’ll be using it in conjunction with a keyer or window to isolate a specific area for special grading.

**TIP:** The Magic Mask palette can even isolate people in photos and paintings. However, figurative representations must have a minimal level of shadow rendering and anatomical detail for a figure or feature to be recognized. For this reason, cartoony or abstract representations won’t isolate very well.

### The Magic Mask Interface

The Magic Mask palette is divided into three sets of controls: the Toolbar, the Stroke list, and the Mask Finesse panel. When you first open the Magic Mask palette, it’s empty, and you’re told to draw a stroke in the Viewer to create a mask.

![The controls of the Magic Mask palette, in Features mode](image)

### Magic Mask Toolbar

A toolbar at the top contains most of the interactive controls of the Magic Mask palette.

- **Target Selection:** A tab control at the left lets you choose the type of mask you want created. There are two choices:
  - **Person:** For creating a mask to isolate as much of a person as visible, given the framing of the shot.
  - **Features:** For creating a mask isolating just someone’s face, or hair, or arms, for example. In Features mode, you can also combine multiple specific features into a single mask.
– **Tracking Controls:** The following controls let you track all available strokes to follow camera or subject motion in the frame. From left to right, these include:

– **Jump to Start of Track:** Moves the playhead to the first tracked frame of a range of tracked frames, in preparation for tracking backwards if there are untracked frames at the beginning of the clip.

– **Track One Frame Backwards:** Tracks one frame backwards and stops. Useful if you’re tracking frame by frame to watch the progress of a particularly complicated bit of motion. If something goes wrong, you can back up to the last frame where the stroke was able to properly track the subject, and drag the stroke to a better location using the pointer to make it follow the subject properly. If necessary, you can go a frame at a time, dragging the stroke to a better position every time it fails to follow the feature you’re using it to isolate.

– **Track All Frames Backwards:** Continuously tracks from the current frame all the way to the beginning of the clip.

– **Stop Tracking:** Stops tracking, in cases where there’s a problem with the track and you want to make a change.

– **Track All Frames Forwards:** Continuously tracks from the current frame all the way to the end of the clip.

– **Track One Frame Forwards:** Tracks one frame forward and stops. Useful if you’re tracking frame by frame to watch the progress of a particularly complicated bit of motion. If necessary, you can go a frame at a time, dragging the stroke to a better position every time it fails to follow the feature you’re using it to isolate.

– **Jump to End of Track:** Moves the playhead to the last tracked frame of a range of tracked frames in preparation for tracking forwards if there are untracked frames at the end of the clip.

– **Stroke tools:** Two tools at the right lets you choose whether to draw strokes to identify the feature you want to isolate, or identify things that aren’t the feature in order to eliminate unwanted excursions in the resulting mask.

– **Invert Mask:** A button lets you invert the resulting mask in cases where you want to use the feature analysis of this palette to isolate everything except the feature or features being analyzed.

– **Mask Overlay:** Turns on an onion-skinned overlay with which to see what parts of the image are being masked alongside which aren’t, so you can continue to refine the result by adding, moving, or deleting strokes. The isolated part of the mask is tinted translucent red.

### Stroke List

Once you start drawing strokes to identify features for mask generation, they appear in this Stroke list.

– **Stroke list header:** The header, at the left of the Stroke list, has controls for selecting, enabling/disabling, and naming each stroke (if you need that level of organization). Right-clicking any stroke in its header reveals controls to Reset Tracking Data and change the mask type (feature or not feature).

– In Person mode, this is just a flat list of strokes, each of which help to either define the person you want to isolate, or the background.

– In Features mode, an additional drop-down menu lets you choose which specific feature you want to identify with a guidance stroke. All strokes are sorted hierarchically by the feature they correspond to, so for example each Face stroke appears underneath a Face title bar. The title bar for each feature has a toggle control that lets you turn that feature off and on. When off, you disable that feature’s contribution to the overall mask being generated.
– **Stroke timeline area:** A Timeline ruler shows the duration of the current clip you’re creating a mask for. Each stroke in this list has a track that displays how many frames of each stroke have been tracked. As you track each stroke, these tracks fill up with colored bars to show which frames have tracking data.

Tracks of strokes that identify a person or features are blue, while tracks for strokes identifying things that aren’t the feature are red. Using this timeline, you can keep track of which strokes need to be tracked, and manipulate the tracking data as necessary to obtain a useful result.

## Mask Adjustment Controls and Matte Finesse

There are two sets of controls for refining the mask that’s output by the Magic Mask palette. The first set of controls, at top, let you adjust how the mask is generated based on the analysis data, which lets you refine the mask result based on characteristics of the image. These include:

– **Quality:** Two options let you choose a tradeoff between quality and performance. Faster lets you generate a lower quality mask more quickly, that’s suitable for garbage matting. Better generates a higher quality mask with more detail, that’s more processor-intensive.

– **Smart Refine:** This control lets you expand or contract the resulting mask based on the analysis of the image, such that expanding the mask doesn’t expand it deeply into surrounding parts of the image that aren’t connected to that person. This operation does not introduce softness. Instead, it enlarges or shrinks the overall mask generated by this palette. 0.5 is unity, 0 is the maximum amount of expansion, while 1 is the maximum amount of contraction.

A second set of mask manipulation controls are for manipulating the mask after it’s been generated. Most of these are the same Matte Finesse controls that are available in the Qualifier palette, which are useful for trying to fix issues with problem masks, or soften the edges when you need to have a more feathered result. For more information about the Matte Finesse controls, see Chapter 134, “Secondary Qualifiers,” in the DaVinci Resolve User Manual. There is one additional control, however, that’s unique to the Magic Mask palette.

– **Consistency:** After you’ve tracked each stroke to follow the subject over the duration of the clip, this setting lets you choose how much temporal smoothing is necessary to ameliorate jitter in the edges of the resulting mask in areas of low confidence, such as frizzy hair or translucent clothing. Higher settings apply more smoothing to the edges of the mask but are more processor intensive and may affect how closely the mask follows motion in the image. Lower settings will be faster and more accurate but may allow more edge jitter in the resulting mask, which can be distracting in the final adjustment you’re making. This parameter defaults to 0, so your first application of Magic Mask will always begin with the most accurate (and potentially most active) application of this feature’s analysis.

**IMPORTANT**

Consistency requires a stroke to have a duration of at least a few frames in order to function correctly. This requires you to track each stroke to follow the motion of the camera and subject in order to extend the duration of each stroke. Because Consistency is trying to eliminate one or two frame “noise” in the shape of the mask, strokes of short duration may end up having their effect eliminated.
Choosing What to Isolate

This section elaborates on the different choices that are available for isolation and offers tips for what each choice is good for.

Person Mode

When you choose Person, every stroke you draw over someone helps to isolate that person’s entire body, or however much of that person is visible onscreen. This includes all clothes that person is wearing, including their shirt, pants, shorts, dress or skirt, bathing suit, knickers, jumpsuits, hat, shoes, even armor or space suit (yes, we’ve tested both), whatever. Most clothing should be correctly identified as part of the isolation mask you’re creating. However, excessively flowing garments may need an extra stroke or two to identify them in complex visual compositions.

Drawing negative strokes, when in Person mode, will identify everything that’s not the person you’re isolating; this omits both the background and/or other people from the mask being generated. Drawing negative strokes isn’t mandatory; you only need to draw a negative stroke if you see a problem such as part of the background being included in the isolation mask.

Features Mode

When you choose Features, a drop-down menu appears at the top of the Stroke list. You must first choose the feature you want to isolate from this menu, and then draw strokes over the selected feature (face, hair, etc.) you want to isolate. Each feature’s collection of strokes can be turned on or off to add that feature to the overall mask being created.

- **Face**: Isolates just the face and ears, including eyes and glasses. This omits hair and the neck (which is considered part of the torso). Facial hair, particularly bigger beards, will usually be omitted from an initial stroke made on exposed skin of the face, so you can work on just the skin if you want. However, an additional stroke on the beard will include it in the face isolation.

- **Hair**: Isolates just the hair, stopping at the bangs and ears, and omitting as much of the face as possible. Curly, frizzy, or wispy hair will produce oversized masks encompassing as much of the hair detail as possible. This tool does not create fine transparency. Fine and irregular hair detail can cause jittery edges, but this can be ameliorated using the Consistency control.

- **Torso (Exposed Skin)**: Isolates exposed skin above the waist and below the face, excluding the arms. This is the selection you want to enable if you want to isolate the neck, neckline, and any part of the chest that’s exposed when wearing v-necks, plunge necks, tank tops, crop tops, or bikini tops.

- **Clothing (Top)**: Any clothing above the waist. Exposed skin is omitted.

- **Clothing (Bottom)**: Any clothing below the waist. Exposed skin is omitted.

- **Arms (Exposed Skin)**: The exposed parts of arms or hands. Shirt and dress sleeves are omitted, as are sun sleeves.

- **Shoes**: Most styles of shoes will be isolated.

- **Legs (Exposed Skin)**: Isolates exposed skin below the torso, excluding socks and leggings.

- **Hat**: Most styles of hats will be isolated, although thin accessories such as streaming ribbons or feathers might not be included.

Remember, no matter what feature you’ve selected to isolate, you can always draw negative strokes to omit other parts of the person or their clothing that are erroneously being included in the mask.
IMPORTANT

When you’re drawing strokes in Features mode, accidentally drawing a stroke over a feature other than the one that’s selected in the drop-down menu at the top of the Stroke list will result in a completely incorrect mask. If you see this happen, delete the stroke you just made, double-check which feature is currently selected, and either redo the stroke or choose the correct feature you want to isolate.

Identifying More Than One Person

In both Person and Feature mode, you can add strokes to identify more than one person, or more than one person’s features. There’s nothing special you need to do, simply draw strokes over each person you want to isolate, or over the same feature of each person you want to include (for example, drawing stroke over three people’s faces in Face mode).

You can draw strokes over multiple people to isolate them together in the same mask.

Using Matte Finesse Controls

There are plenty of situations where a seemingly problematic mask can be improved using the Smart Refine and Matte Finesse controls at the right of the Magic Mask palette. If the mask is only a few pixels off, and the color adjustment you want to make is reasonably subtle, you can probably use Blur Radius and In/Out Ratio to create a soft edge that falls off just at the outer edge of the subject (so as not to create a halo effect) with which to make your adjustment.

(Left) The hard edges of the initial mask aren’t quite close enough to the edges of the woman’s arm to make a subtle adjustment. (Right) Using the Blur Radius and In/Out Ratio controls to create soft edges that don’t extend past the subject to make a useful mask.
Using Magic Mask as a Garbage Matte

In situations where the outer edge of a person is not being detected closely enough for Magic Mask to give a useful result for a more extreme color adjustment, you're probably better off expanding the result into a closely-fitting garbage matte to use for isolating the person or features using other techniques, such as a keyer in the Qualifier palette. Even for this purpose, you'll find using Magic Mask is typically faster than rotoscoping a relatively close garbage matte over a moving figure using windows.

Dealing With Hair

Wispy or frizzy hair, individual strands of hair being thrown back, and tips of dreadlocks or heavily moussed hair that comes to points will often require special handling with this tool. Keep in mind that the Magic Mask tool does not specialize in soft translucent mask edges like a keyer does. When it comes to hair styles that are loose and free, in many situations you may be able to finesse an acceptable result using the Matte Finesse controls to expand a softened version of the matte to encompass the entire hairstyle.

If this interferes too much with the edges of other features of the subject you're isolating, you can create a dedicated hair mask in Features mode by drawing Hair strokes. You can then use the Matte Finesse controls at the right of the palette to create softened edges that work well with the outer boundary of the hair style you're isolating.

Creating a soft-edged hair mask

At this point, you can try doing different color adjustments using two different correction nodes, one for the subject’s hair, and another using Magic Mask to isolate everything but the hair.
Alternately, if you want a single matte with which to isolate the entire subject, you can then use additional instances of the Magic Matte tool (one per node), using one node to isolate just the face and body without the hair, and a third node to isolate the entire subject but with a very soft edge. Then, you can use a Key Mixer node to combine all these masks together with the original hair mask you created, with which to feed a complete key to another node used to make the correction.

While hair with soft edges can be a challenge, Magic Mask excels at many elaborate hair styles with detailed shapes and hair accessories, including jewelry and ribbons. For example, the stylized hairstyles found in European and Chinese period movies and shows give the DaVinci Neural Engine no trouble at all, particularly as these styles are usually tightly bound with no wispy hair.

Asymmetrical hairstyles may require extra strokes to identify hair that’s significantly longer on one side of the face. This may also be true for unorthodox hair styles, such as hair that’s been sculpted into distinct sculptural shapes. Lastly, tight braids that expose skin on the scalp are also challenging for the kind of hard masks that Magic Mask produces, so you’re better off using Magic Mask as a garbage matte and using a keyer to create a detailed soft mask to use in these instances.

About Hats

Magic Mask works with an incredibly wide variety of hats from all time periods. On hats, tassels or details like feathers can be a problem (in testing, the feather on Errol Flynn’s cap in Robin Hood couldn’t consistently be included, even though the cap itself was no problem). Additionally, veils that are part of hats may or may not be easily identified, but an additional stroke usually solves the problem.

Dealing With Accessories

Things that people are holding, such as handkerchiefs or umbrellas, can pose problems. Sometimes, something that’s obvious like the blade of a sword will be omitted, while the hilt that’s being held in a hand is included with the figure. In these instances, you can choose whether you want to draw another stroke to include the item in the mask, or try to draw a negative stroke to omit it. Your results will vary with the size of the item.

Jewelry and watches pose a special problem, as they’re typically so thin and small that they can be difficult to omit, but you may not want to include them depending on the adjustment you’re trying to make. Your results will vary with the thickness of the items and the framing of your subject, but in general your results will probably be better if you simply add a stroke or two to include these items in the isolation, since omitting fine detail like a necklace can be problematic.
Adding Strokes to Guide Mask Creation

Here are some tips for how to draw strokes to analyze the image. To identify people, try starting with a single short positive stroke (blue), centered on the face or body.

Drawing the first stroke to identify an entire person

Depending on the result, more strokes may be needed to differentiate an arm or frizzy hair from the background. If you’re adding a stroke to an arm or hair, don’t put it right at the edge; the goal is not to trace the subject, but to use strokes within the body of the subject to clarify what features belong to the subject, and which do not.

Adding a stroke to the arm to include it as well

As you do this, resist the urge to use too many strokes. One stroke might well be all you need, or you might need two or three, but using more than five strokes for any subject or feature may cause more problems than it solves.

Adding negative strokes to the reflection to remove
To identify faces, try starting with a single short stroke in the middle of the face, along the nose, or from eyes to the lips. Depending on the result, you may need additional strokes to identify the chin, a beard, or to distinguish the forehead from wispy hair.

![Image of a face with a single stroke along the nose]

Drawing strokes to identify a face; notice that additional strokes are needed to include the beard.

It’s a good idea to start with a single stroke, then track the stroke through the duration of the clip (described later in this section). Over the entire clip, you’ll see which parts of the mask may exhibit problems. This will guide where you put additional strokes, in order to more clearly identify the person versus the background, in order to clean up the resulting mask. As you add additional strokes, track those as well and see how things go.

If you notice parts of the background that are erroneously added to the mask, you can add a negative stroke (red) to clarify that those parts of the image should not be isolated. Short strokes, longer strokes, and zig zags are good for backgrounds. Since strokes just help the analysis update the mask, you can try different types of strokes to see what works best, and delete any stroke that doesn’t give good results. As with positive strokes, don’t use more strokes than are absolutely necessary to get the result you want.

![Image of a microphone with negative strokes]

(Left) The microphone incorrectly identified as part of the woman being interviewed. (Right) Drawing negative strokes to identify the microphone as background, using a zig-zag pattern to tag the entire microphone.

Similarly, if you’re isolating features such as a face, and you find other features, such as hair, getting in the way, you can draw a negative stroke on the hair to identify it as not part of the face.
If there’s a “hole” in the resulting mask that’s actually part of the background and not the subject, you can try drawing a stroke connecting that hole to the rest of the background.

![Drawing strokes to connect the background with itself, to remove part of the mask that's not part of the person](image)

If there’s an “island” in the mask that’s actually part of the subject and not the background, you can try drawing a stroke across the island that connects one solid part of the mask to itself.

![Drawing strokes to fill an island in the subject being isolated](image)

Of course, extracting a mask using strokes is only the first part of creating a useful mask. The Quality, Consistency, and Smart Refine controls let you refine the stroke analysis of the image to create the best tradeoff between performance and quality for the type of mask you need. These controls work hand in hand with the strokes you draw to extract a mask. A set of Mask Finesse controls then let you adjust the resulting mask to manipulate and soften it, to better suit whatever adjustment you’re trying to make. All of these controls are described earlier in this section.

### Managing Strokes in the Stroke List

When you draw a stroke, it appears in the Stroke list. By default, all strokes last for the duration of the clip to which they’re applied, so if you draw a stroke to identify a figure that’s not moving, there’s no requirement to motion track or keyframe the stroke. Strokes in Person mode appear in one long list, while strokes in Features mode appear hierarchically, with the strokes for each feature separated by the title of each feature. Once a stroke appears in this list, it has the following controls.

- **Enable/disable feature:** In Features mode, once you draw at least one stroke to identify that feature, the title of that feature appears, underneath which is organized all the strokes for that feature. A toggle next to the feature name lets you turn that feature’s contribution to the overall mask on and off.

- **Enable/disable stroke:** Each individual stroke in this list has a blue dot that lets you turn that stroke’s contribution to the overall mask on or off.
– Stroke Timeline Area with Stroke Tracks: The stroke track for each stroke lets you keep track of and manipulate the animation of strokes to follow camera and subject motion. Blue or red frames in this track let you see at a glance how much of each stroke has been motion tracked; blue frames for positive strokes, red frames for negative strokes. You can also use these tracks to identify frames where you’d like to mute that stroke’s contribution to the final mask and to keep track of which frames have been muted. You can draw a bounding box within the stroke track around however many frames of however many strokes for which you want to delete motion tracking, delete keyframes, or mute stroke contributions to the mask.

**Stroke Duration**

When you first draw a stroke, that stroke has a duration of one frame, located at the timecode position of the playhead when you drew it. If you move the playhead to the left or right, you’ll see the stroke disappear. If you want one or more strokes to continue analyzing the subject for the duration of that shot, you need to use the Motion Tracking controls to track the stroke to follow along with the motion of whatever it’s drawn on top of. As a stroke is tracked, its duration increases to cover the entire range of tracked frames. If at any point a stroke outlasts its usefulness, such as when a person walks off frame, you can stop tracking that stroke when it’s no longer necessary and it will stop contributing to the analysis.

This is useful, because often you’ll want to place strokes to deal with analysis issues that only last for a few frames, to fix a hole in the mask that only appears briefly. Just be aware, you can’t simply draw a stroke and move on to the next shot; you must track at least one stroke to last for the duration of a subject’s time on screen for that subject to be continuously masked.

**Tracking and Keyframing Strokes to Follow Subject Motion**

You can think of each stroke you’ve drawn as a persistent eyedropper that samples the image that overlaps it. The mask that results from all strokes’ collective analysis of the image is generated live over each frame of the clip. This means that if the camera or the subject moves, you need to motion track or otherwise adjust the position of each stroke to follow along with the motion, so the subject continues to be correctly identified. You also need to make sure that each stroke is able to analyze what it’s supposed to, and turn off strokes that can’t for whatever reason.

**TIP:** Magic Mask is a processor-intensive operation, so to accommodate users of less powerful workstations, there is a Use Fast Tracking option available in the Magic Mask palette’s Option menu, which speeds up the process of tracking at the expense of potentially less accurate tracking for fast or erratically moving subjects.

**Methods of Moving Strokes to Follow Subject Motion**

For these reasons and more, there are multiple methods of manipulating strokes to refine the final analysis.

– **Motion Tracking:** A set of tracking controls at the top of the Magic Mask palette let you motion track one or more strokes to follow the camera and subject motion in a clip. Every frame that’s motion tracked effectively has a motion-tracked keyframe placed on it that moves the stroke to a new position.
Manual Keyframing: Any time you drag a stroke from its original position in the Timeline, you create a static keyframe at that frame that instantly moves the stroke from its previous position to the new position at that frame. Because these are static keyframes, there’s no motion interpolation from one keyframe to the next in order to create animation. Instead, keyframing in the Magic Mask palette is a simple frame-by-frame operation. Every time you move a stroke at a new frame, you change the stroke’s position at that frame, without changing stroke position on any other frame that’s been previously tracked.

If this seems simplistic, keep in mind that the goal is not to create beautiful stroke animation with this tool. You only need to move each stroke to follow along with whichever subject or background feature it’s supposed to be sampling in each frame. The only important thing is that, in every frame, the stroke overlaps a suitable part of the feature you’re isolating to create the appropriate mask. If the stroke itself jumps around abruptly, that doesn’t matter so long as the mask that’s generated is good. This means that even if you’re stuck doing a limited amount of frame-by-frame animation to make a stroke follow along with a troublesome feature (such as a veil flapping in the wind), it’ll go pretty fast, because in each frame you’re just dragging the stroke to overlap the feature wherever it happens to have moved. This repositioning doesn’t have to be smooth, just accurate.

Combining Tracking and Manual Keyframing: Since each frame that’s motion tracked is effectively keyframed, manually dragging a stroke on a frame that’s already been tracked overrides the tracking data at that frame with a static keyframe that records the new position of the stroke at that frame. If there’s no more tracking data, either before or after that keyframe, then the stroke disappears until you do more tracking. If there’s tracking data immediately after a keyframe, then the stroke jumps to the position dictated by that tracking data.

Deleting Stroke Tracking at Specific Frames: To accommodate cases where a subject you’re isolating moves behind something and becomes hidden for a range of frames, you have the ability to delete stroke tracking for one or more frames. This lets you eliminate the stroke for however many frames the subject you’re tracking is obscured and cannot be sampled. This makes it easy to deal with features that come and go over the duration of a clip, since you can delete stroke tracking over however many ranges of frames the feature disappears. If you’ve muted frames by mistake, you can either undo or re-track the stroke over those frames.

To delete tracking frames, draw a bounding box on the stroke tracks over the range you want to delete, and then choose Clear Selected Track Data from the Magic Mask option menu.

Option Menu Commands for Removing Strokes and Tracking

The Option menu of the Magic Mask palette presents a number of commands for clearing either strokes or stroke tracking data.

- Clear All Strokes: Deletes every stroke in the Stroke list, along with tracking.
- Clear All Strokes of Current Frame: Deletes the tracking data at the current position of the playhead on all strokes in the list.
- Clear All Strokes from In to Out: If you use the I and O keys to set In and Out points in the Stroke Timeline, this command deletes all tracking data on all strokes within that range.
- Clear Selected Stroke from In to Out: If you select a stroke in the Stroke list, and then use the I and O keys to set In and Out points in the Stroke Timeline, this command deletes the tracking data of selected strokes within that range.
- Clear Selected Track Data: If you drag a bounding box around tracking data for one or more strokes, this command deletes all tracking data within the box.
An Example Stroke Tracking Workflow

By combining motion tracking, manual keyframing, and stroke muting, you'll be able to make short work of isolating most moving subjects. The following procedure illustrates how you might use these techniques together to make the strokes you've drawn follow along with the features you're isolating.

To track one or more strokes to follow a subject:

1. If necessary, move the playhead to the frame where you want to begin isolating the subject you want to mask. For example, if you're isolating a person walking into the room through a door, you probably want to begin your work on a frame where the person is already in the room, and work your way backward and forward from that frame. If your subject is already fully visible at the first frame of the shot, you can start there.

2. Draw at least one stroke identifying the subject or feature you want to isolate. You cannot track a stroke to follow the features unless there's at least one stroke.

3. Choose whether you want to track all strokes or only selected strokes. By default, all existing strokes with at least one frame in the Stroke Timeline at the position of the playhead will be tracked. However, you can choose to track only selected strokes in the Stroke list by choosing Track Selected Stroke Only in the Magic Mask palette's Option menu.

4. Click the Track Forwards to End or Track Backwards to Beginning buttons if you want to motion track the strokes over the remaining duration of the clip.

   By default, each stroke is tracked to follow whatever image detail immediately surrounds it; you don't have to define a tracking region, this is done automatically. As tracking proceeds, the tracking bar for each stroke will fill up showing you which frames have been tracked, and which have yet to be tracked. Meanwhile, each stroke being tracked will transform to follow along with simple position and rotation changes in the subject. However, things that obscure the subject, as well as more extreme movements, may cause problems.

   Strokes that are tracking a feature that moves off screen are automatically excluded from tracking at the frame where the feature is completely off screen, even if that feature returns onscreen in a later frame.

5. (Optional) If a problem occurs during the track, such as the subject being occluded behind something else in the frame (for example, a person's face moves behind a tree as they walk), click the Pause Track button. You can deal with problems in the track in the following ways:

   a. If a stroke has completely moved off of the subject: For example, you're tracking a stroke to follow a person and they turn around 180 degrees, so the stroke moves off onto the background. To fix this, pause the track, move the playhead to the first frame where the stroke hasn't followed the subject properly, then use the pointer to drag the stroke onto another part of the subject that's clearly visible. On each frame where you drag the stroke to a new position, it will be automatically keyframed. Continue this process until the subject's motion is consistent enough to be trackable again, and you can then resume tracking.

   b. If a stroke has moved onto something that's partially obscuring the subject: Pause the track, drag a bounding box over the frames where the track is having a problem, and choose Delete Selected Tracking from the Magic Mask Option menu to clear the bad tracking data. Then, move the playhead to the first frame of the deleted tracking data, and use the pointer to drag the stroke onto any part of the subject that's visible to either side of the occlusion. Move the playhead to each successive frame, and drag the stroke onto whichever part of the subject is visible from behind the occlusion, until the subject moves past the occlusion. At that point, you can use the Track Forwards to End or Track Backwards to Beginning buttons to continue tracking as usual.
c. If the subject becomes completely hidden: Clips where the subject appears and disappears over the duration of a clip can be resolved by deleting the stroke or strokes on that subject over all frames where the subject is obscured, so that strokes only sample the image when the subject is visible and thus able to be isolated. You can delete one or more strokes by dragging a bounding box over a range of frames, and then choosing Clear Selected Track Data from the Magic Mask Option menu.

d. If a stroke is having trouble following the subject: If the subject you’re tracking is moving too fast, too irregularly, or is changing shape too greatly for the tracker to give a good result (for example, someone lifts their arm towards the camera), you can track through the problem area of the clip one frame by frame using the Track Forward 1 Frame or Track Backward 1 Frame buttons, and then use the pointer to manually drag the stroke to follow along with the subject as you go. Once the problem motion stops and the motion of the subject becomes more regular, you can use the Track Forwards to End or Track Backwards to Beginning buttons to continue tracking as usual.

e. If the subject is moving off the frame: If you’ve drawn a stroke in the middle of someone’s face, and their face is moving off screen, you can manually reposition the stroke on the last few frames before the subject completely exits so that stroke continues to identify what parts of the face are still visible even though the part of the face it was originally following becomes hidden. Once the face completely exits the frame, you can mute the stroke for the rest of the shot.

6 (Optional) If you only tracked the stroke’s movement over part of a shot, you can click the Jump to Start or Jump to End buttons to move the playhead to the first or last tracked frame, in preparation for tracking from that frame onward.
While Power Windows can be manually keyframed to follow a moving subject you want to isolate, this chapter shows how you can use the powerful cloud and point-based motion tracking controls in DaVinci Resolve to make Power Windows follow along with the motion of subjects and the camera in the fastest, easiest way possible. Then, numerous techniques are presented for dealing with complicated tracking scenarios and common problems that arise for subjects that are difficult to track.

Contents

Motion Tracking Windows
Simple Tracking Using the Tracker Menu
Tracking Windows When You’ll Be Exporting Media With Handles
Simple Ways of Working With Existing Tracking Data
Tips for Better Tracking
Tracking One Frame at a Time
Copying and Pasting Tracking
Tracker Palette Controls in More Detail
Controls in the Window Tracker Palette
Cloud Tracker Workflows
Using Interactive Mode to Manually Choose Tracking Features
Dealing With Occlusions When Tracking
Point Tracker Workflows
Tracking a Window Using the Point Tracker
Removing Trackers
Using Frame Mode to Offset Track
Motion Tracking Windows

The Tracker palette has three modes, available from the Palette menu.

- In Window mode, the tracking controls let you match the motion of a window to that of a moving feature in the frame.
- In Stabilizer mode, the same underlying technology is used to smooth or stabilize the motion within the entire frame.
- In FX mode a Point Tracker can be used to animate ResolveFX or OFX plug-ins with positioning controls. For more information about the FX and Stabilizer modes, see Chapter 150, “Sizing and Image Stabilization.”

DaVinci Resolve has an incredibly simple, yet powerful, 3D cloud tracker that allows you to track quickly and accurately any Power Window (Circular, Linear, Polygonal, Curve, or Gradient) to follow any moving feature. This avoids the need to use dynamic keyframes to manually animate a window’s position.

In particular, you can use the tracker to match a window’s position, size, rotation, and its pitch and yaw in 3D space to either foreground or background elements that move within the frame.

Simple Tracking Using the Tracker Menu

The simplest way to track a feature using a Power Window is to use the commands found in the Color > Tracker menu. These commands include:

- Track Forward (Command-T): Tracks a window to a feature from the current position of the playhead forward, ending at the last frame of a clip.
- Track Reverse (Option-T): Tracks a window to a feature from the current position of the playhead backward, ending at the first frame of a clip.
- Track Stop (Command-Option-T): Interrupts any track. This is useful for letting you cancel a long track that goes wrong (the Stop button of a control panel stops tracking as well).
Most window tracks are easy to accomplish using these three commands.

**To track any Power Window to match a moving feature within the frame:**

1. Move the playhead to the frame of the current shot where you want to begin (you don’t have to start tracking at the first frame of a shot).
2. Turn on any window, and adjust it to surround the feature you want to track.
   Typically, you’ll have done this anyway, for example, framing someone’s moving face with a Circular window to lighten their highlights.
3. To initiate tracking, do one of the following:
   - Choose Color > Tracker > Track Forward (press Command-T).
   - Choose Color > Tracker > Track Reverse (Option-T).

DaVinci Resolve automatically opens the Viewer page, places a series of tracking points within the window you’ve created, and performs the track from the current frame; forward to the last frame or backward to the first frame.

DaVinci Resolve analyzes a cloud of tracking points that follow the vectors of every trackable group of pixels within the window you’ve created, and the results are fast and accurate. After tracking, the window you’ve placed automatically moves, resizes, rotates, and skews to match the motion of the feature you’re tracking.

Once a clip has tracking data applied to one of its windows, a small tracking icon appears within that clip’s icon in the Thumbnail timeline.

If the track you’ve performed is unsuitable, you can reposition the window to cover a different area of the subject you’re trying to track, and initiate tracking again. New tracking data overwrites any previous tracking data applied to that window.

Once you’re satisfied with your track, you can continue to resize, reposition, or reshape the window being tracked. Tracking data is separate from the window transform parameters (which can be keyframed), so changes you make to a window offset it from the originally tracked path.
Tracking Windows When You’ll Be Exporting Media With Handles

When you track windows to match moving features in a clip, the windows are only transformed on frames with tracking data. In Round Trip workflows where you add handles to the graded clips you render for editorial flexibility in the footage you deliver, you need to make sure that you track all windows from the beginning to the end of these handles to make sure that, if an editor actually trims any of the clips you give them to use the handles, all windows are doing what they should.

An easy way to do this is to choose View > Show Current Clips With Handles to display each clip you select in the Timeline with handles defined by the “Default handles length” setting in the Editing panel of the User Preferences. Make sure that the “Default handles length” is equal to the handles you export using the “Add X Frame handles” option in the Render Settings list of the Deliver page. With each clip’s handles made visible in this way, you can easily track windows along every frame you’ll be rendering.

Simple Ways of Working With Existing Tracking Data

If there’s a portion of a shot that you haven’t tracked (for example, you started tracking at a later frame, or you ended tracking before the end of the shot), then the window you’re tracking remains wherever it was at the first or last frame that was tracked. If you want to fill in these gaps, you can always move the playhead to the first or last frame that was tracked, and then use the Track Backward or Track Forward command to track the rest of the frames in that shot.

Tips for Better Tracking

In situations where a feature changes shape in such a way as to confuse the tracker, you can try tracking a smaller part of the feature by using a smaller window. Once you’ve achieved a successful track, you can resize the window as necessary, and it will have no effect on the track that’s already been made.

Also, if you’re tracking a feature that moves behind something onscreen and disappears for the rest of the shot, there’s an easy way to avoid having an awkward window sitting in the middle of the scene. You can use dynamic keyframes to animate the Key Output Gain parameter (in the Key tab of the Color page) to fade from the correction’s full strength of 1.0 down to 0, the value at which the correction disappears, along with the window itself.

Tracking One Frame at a Time

You can click the “track one frame forward” or “track one frame backward” buttons in the Tracker palette to track a moving feature one frame at a time, making it easier to make adjustments to follow a difficult track when you’ve set tracking to Frame mode (by clicking the Frame button).

In Frame mode, you can keyframe window transformations to more faithfully conform to troublesome motion as you’re moving one frame at a time through the track; manual changes to a window’s position will be keyframed to create frame-specific transformations, rather than used to offset the entire tracked motion path as in Clip mode. When you add multiple keyframes in the Tracker graph, animation will be automatically interpolated from keyframe to keyframe.

Copying and Pasting Tracking

There will be plenty of times you’ll apply multiple windows to a single moving subject, such as a car, when you can use a single motion track for all the windows. Commands in the Option menu let you copy and paste track data from one window to another within the same node, saving time when you want several windows tracking together as one.
To copy track data from one window to another:

1. Open the Window palette, then select a window that has tracking applied to it (indicated by a tracking badge in the corner of the shape icon), and choose Copy Track Data from the Option pop-up.

2. Select another window, and choose Paste Track Data from the Option pop-up. Once you’ve copied track data from one window, you can paste it to as many other windows as you like.

You can also copy tracking from the FX mode of the Tracker palette and paste it to a window, in case you want to use the same tracking data for both an effect and a window.

To copy track data from an FX track to a window:

1. Open the Tracker palette, choose the FX mode that contains the tracking data you want to copy, and choose Copy Track Data from the Option pop-up.

2. Open the Window palette, select a window, and choose Paste Track Data from the Option pop-up. Once you’ve copied track data from one window, you can paste it to as many other windows as you like.

Tracker Palette Controls in More Detail

You can easily combine object tracking and keyframing to animate windows. For example, you’ll typically use object tracking to make a window follow the position and orientation of a moving feature, but you can add dynamic marks to the window track of the correction in the Color page with which to alter its size and shape to better conform to a feature’s changing form.

Controls in the Window Tracker Palette

Occasionally, you’ll run into a shot that doesn’t quite track well enough using the Tracker menu’s simple controls. In these cases, the Viewer page provides the complete set of object tracking controls that can be used to modify tracking operations in different situations.

The Tracker palette

The object tracking controls are divided into seven groups.

Tracker Palette Modes

The Tracker palette’s Option drop-down menu lets you choose between Window mode (for matching a window to the motion of a feature in the frame), Stabilizer mode (for subduing unwanted camera motion; for more information on Stabilizer mode, see Chapter 150, “Sizing and Image Stabilization”), and FX mode (for tracking position to be used with Resolve FX or Open FX plug-ins).
Types of Tracking

A pop-up menu below the Tracker graph lets you choose whether to use the Cloud Tracker or the Point Tracker.

There are two options:

- **The Cloud Tracker**: Automatically analyzes all parts of the image for trackable points, and uses these to automatically figure out the motion in the shot that you want to use to move a Power Window or stabilize a shot. This tracker type is great for quickly tracking a window to match the movement of almost any feature, with a minimum of work.

- **The Point Tracker**: Lets you create one or more tracker crosshairs that you can manually position in order to track specific features in the shot. The more crosshairs you create and position, the more accurate the track can be. The Point Tracker is incredibly useful in situations where you need to follow the motion of a very specific feature in the frame. It can also be useful in cases where you want to stabilize a shot that has many subjects moving in different directions, and it’s difficult to obtain a good result with the Cloud Tracker.

Object Tracking

The object tracking controls provide the most basic tracking functions, some of which are mirrored within the Color > Tracker menu.

A series of five checkboxes let you turn on and off which transforms you’d like motion tracking to apply automatically to the window. These checkboxes must be selected before you perform a track in order to restrict the transforms that are used.

- **Pan and Tilt**: Enables tracking of horizontal and vertical position, when you want to transform a window to follow the location of a tracked subject.

- **Zoom**: Enables tracking of size, when you want to transform a window to resize to follow a tracked subject.

- **Rotate**: Enables tracking of orientation, when you want to transform a window to rotate with a tracked subject.

- **Perspective 3D**: Enables tracking of pitch and yaw in 3D space, when you want a window to skew to follow the orientation of a tracked subject within the scene. Good when you want the window to “stick” to a surface.

**NOTE**: Once tracking or stabilization has been done, disabling these checkboxes does nothing to alter the result. To make changes, you need to enable or disable the necessary checkboxes first, and then reanalyze the clip.
After you’ve defined the transforms you want to use for the track, the analyze controls let you proceed with the analysis of the subject being tracked.

- **Track One Frame Reverse button:** Motion tracks a single frame in reverse. Useful for slow tracking of difficult subjects that may require frequent correction.

- **Track Reverse button:** Initiates tracking from the current frame backward, ending at the first frame of the clip. Good for tracking backward when your best starting point is somewhere within the middle of the shot.

- **Pause button:** Stops tracking (if you’re fast enough to click this button before tracking is finished).

- **Track Forward button:** Initiates tracking from the current frame forward, ending at the last frame of the clip.

- **Track One Frame Forward button:** Motion tracks a single frame forward. Useful for slow tracking of difficult subjects that may require frequent correction.

### Clip/Frame Controls

Two buttons let you set how manual adjustments to the position of tracked windows affect the overall track.

- **Clip:** The default mode, in which changes you make to the position of a window are globally applied to the entire track. For example, if you track a feature, and then move the window, the window moves along a motion path that’s consistently offset from the original track for the duration of the clip. Use this mode if you’re happy with the track, but you want to modify the window’s overall shape and position relative to the motion path it’s following.

- **Frame:** In this mode, changes you make to the position or shape of a window create a keyframe at the frame at the position of the playhead. Multiple keyframes are interpolated to create animation with which you can manually transform a window to solve a variety of problems. This mode is useful for rotoscoping the shape and position of windows to match a subject that’s tough to automatically track. Frame mode is also useful for making corrections to individual frames that were badly tracked, for animating windows to go all the way out of frame along with a subject, or for making manual, frame-by-frame adjustments to window position to cover untrackable sections.

### The Tracker Graph

The Tracker graph provides a visual display of the tracking data that’s being analyzed. Each of the transform controls that can be tracked has an individual curve, which lets you evaluate each tracked parameter on its own, and each curve is color-coded to match the corresponding label of the tracking transforms listed above.
A vertical slider to the right of the Tracker graph lets you scale the height of the curve data within to make it easier to see it all within the graph. A horizontal slider at the bottom of the graph allows you to zoom in and out of the tracker curves, allowing you to see finer detail of the tracking paths. Above the Tracker graph, a Timeline ruler contains a playhead that’s locked to the playheads in the Viewer and Keyframe Editor.

You can draw a bounding box in the Tracker graph with which to select a portion of one or more curves to delete sections of low-quality tracking data using the Clear Selected Keyframes command found in the Tracker Options menu. To eliminate the current bounding box from the Tracker graph, click once anywhere within the graph.

**Interactive Mode Controls**

The Interactive controls, at the bottom-left of the Tracker palette, let you make manual changes to the automatically generated tracking point cloud that DaVinci Resolve creates when you’re tracking with the Cloud Tracker, so you can try different ways of obtaining better tracking results in challenging situations.

**Interactive mode controls**

- **Interactive Mode checkbox**: Turns the Interactive tracking mode on and off. When you enter Interactive mode, you can manually alter the point cloud that DaVinci Resolve uses to track the feature within the current window. You’ll then make your track while in Interactive mode.

- **Insert**: Lets you add tracking points to whatever trackable features exist within a bounding box that you’ve drawn in the Viewer. Inserted tracking points are automatically placed based on trackable pixels in the image.

- **Set Point**: Lets you use the cursor (using the DaVinci Resolve Advanced control panel), to manually place individual tracking points, one by one, with which to track a feature. If there is no trackable pixel group at the coordinates where you placed the cursor, a tracking point will be placed at the nearest trackable pixel group.

  You must place at least two tracking points at different pixel groups to track rotation, and at least three to track zoom.

- **Delete**: Eliminates all tracking points within a bounding box that you’ve drawn in the Viewer.

**Point Tracker Controls**

If you’re using the Point Tracker, then the Interactive Mode controls disappear, replaced by the two controls of the Point Tracker.

**Point Tracker controls**

- **Add Tracker**: Click to create a new tracker that’s automatically positioned in the center of the frame. Once created, you can drag it using the pointer to line up with the feature you want to track. You can create as many trackers as you like. Multiple trackers are all tracked at once.
Delete Tracker: Select any tracker (selected trackers are red, deselected trackers are blue), and click this button to remove it.

Additional Commands in the Tracker Options Menu
There are some additional commands located in the Tracker Options pop-up menu.

- Reset Track Data on Active Window: Lets you delete the tracking data corresponding to the currently selected window.
- Clear Selected Track Data: When you drag a bounding box over parts of one or more curves in the Tracker graph, this command lets you delete that part of the graph. This is useful when you want to eliminate sections of low-quality track data. Portions of curves that are cleared in this way have linear interpolation automatically applied to them, similar to if you used the Keyframes Interpolation controls.
- Delete Keyframe: Deletes tracker graph keyframes at the current position of the playhead.
- Clear All Tracking Points: Clears the tracking points in the Power Window at the frame you are on.
- Show Track: Turn this checkbox on to show the motion path produced by the tracking you’ve done.
- Copy Track Data: Lets you copy track data from the currently selected window. Windows can be selected directly in the Viewer while the Tracker palette is open.
- Paste Track Data: Pastes copied track data to the currently selected window. Windows can be selected directly in the Viewer while the Tracker palette is open.

Cloud Tracker Workflows
The next few examples illustrate how to use the Tracker palette’s controls in practical situations. In many circumstances, objects passing in front of a tracked subject, known as “occlusions,” can cause problems. While the tracker in DaVinci Resolve is highly occlusion-resistant, the following sections show a variety of techniques you can use when an occlusion prevents you from getting a useful track.

Using Interactive Mode to Manually Choose Tracking Features
Interactive mode lets you manually remove or add tracking points to improve tracking performance in situations where the automatic image analysis in DaVinci Resolve provides unsatisfactory results.

For example, you can delete tracking points within a window that correspond to overlapping features you don’t want to track. Suppose a car that you’re tracking drives by a sign that partially obscures the car. Without intervention, the PowerCurve that’s isolating the car will deform improperly when the car moves along and then away from the sign.

Using Interactive mode, you can delete the tracking points that will overlap the sign you don’t want to track, improving the result.

To eliminate specific, unwanted tracking points from a track:
1. Open the Tracker palette.
2. Turn on the Interactive Mode checkbox.
3  In the Viewer, drag a box around the tracking points you want to eliminate within the window.

![Dragging a box around tracking points that need to be deleted](image)

4  Click the Delete button.

![Deleting tracking points](image)

The points within the selection area are deleted.

![Remaining tracking points ready to be used](image)

5  While Interactive mode is still on, click Track Forward or Track Reverse to track the subject using the remaining tracking points.

6  When you’re finished tracking, turn off the Interactive Mode checkbox.

DaVinci Resolve goes back to using automatically placed tracking points.

In another interactive tracking example, you may sometimes run into situations where you want to eliminate all automatically placed tracking points altogether, placing your own in specific regions of the image.

**To eliminate automatic tracking points, adding your own instead:**

1  Open the Tracker palette.

2  Turn on the Interactive Mode checkbox.
3 In the Viewer, drag a box around all the tracking points in the window, and click the Delete button to eliminate all tracking points from the image.

4 Click the Delete button to eliminate all tracking points from the image.

5 Drag a box around the specific area where you'd like to add new tracking points. In this case, you only want to track the top half of the woman's face, since the bottom half is cut off by the fence posts.

6 Now, click the Insert Track Points button.
The Insert button of Interactive mode automatically adds tracking points within the current bounding box.

New tracking points are automatically added to whichever features are appropriate for tracking within the box you’ve drawn.

NOTE: If no appropriate tracking features can be found, no points will be added.

Dealing With Occlusions When Tracking

Sometimes you’ll find that you need to deal with a gap in the useful tracking data. For example, objects in the frame that pass in front of the feature you’re trying to track cause gaps in the tracking information for a clip.

In situations where a subject being tracked becomes totally occluded by another object in the frame, there’s an easy method of interpolating to cover holes in the available tracking data. In the following example, the woman walks behind another fence post, this time one that’s taller than she is. The window tracking her face will become completely lost at this point, but interpolation will help to salvage this shot.
Interpolating between two sets of tracking data to track past an occlusion:

1. Move the playhead to the first trackable frame of the moving feature you’re correcting, and create a Power Window that surrounds it.

![Adding the Power Window](image1.png)

2. Use Track Forward to track the feature as far as you can before it becomes obscured behind something else in the frame.

![The Power Window is obscured by the post](image2.png)

3. When the Power Window stops tracking the feature reliably, stop the track.

4. Open the Tracker palette.

5. Click the Frame button to put the Tracker controls into frame-by-frame adjustment mode. This is an important step.

![Selecting Frame mode](image3.png)

6. Move the playhead to the frame where the feature you’re tracking reappears from behind the occlusion, then drag the window so that it again overlaps the feature.

![Moving the playhead and position the window](image4.png)
7 Use Track Forward to continue tracking the feature until the end of the clip. Alternately, you could have started from the end of the clip and used Track Reverse to track the feature as far as possible, if that’s easier.

Now that you’ve identified the gap in reliable tracking data for this clip, it’s time to set up the interpolation.

8 Drag a bounding box over the portion of the curves in the Tracker graph that fall between the good tracking data at the beginning and end of the shot.

9 Click the Tracker palette option pop-up menu, and choose Clear Selected Track Data.

The portions of curves that you selected are deleted, and have linear interpolation automatically applied to them so that there’s no hole in the track data or the motion of the window, which now moves smoothly from the last outgoing frame of reliable tracking data to the first incoming frame of new reliable tracking data.

**Point Tracker Workflows**

As advanced as the Cloud Tracking that is the default in DaVinci Resolve is, there are times when it may be simpler to track using good old-fashioned crosshairs. The Point Tracker makes it easy to track very specific features of a subject with motion you need to follow. Unlike the Cloud Tracker, which automatically looks for all trackable points within a region of the image that you identify using a window, the Point Tracker lets you create one or more crosshairs that you must manually position to overlap with whatever high-contrast features you want to track. This section covers the three main workflows you need to know to use the Point Tracker.
Tracking a Window Using the Point Tracker

The following procedure describes, in a general way, how to use the Point Tracker to track a moving subject and apply that motion to a Power Window.

1. Move the playhead to the frame of the current shot where you want to begin (you don’t have to start tracking at the first frame of a shot, since you can always track backward).

2. Turn on any window, and adjust it to surround the feature you want to track. Typically, you’ll have done this anyway, for example, framing someone’s moving face with a Circular window to lighten their highlights. You want to make sure that the window you want to apply the tracked motion to is selected before you begin tracking. In this example, we’ll be tracking a Circular window to follow the woman’s face.

3. Open the Tracker palette, and choose Point Tracker from the bottom right pop-up.

4. Before you start tracking, choose what types of motion you want to track and apply to the window you’re working on. You can choose from among Pan, Tilt, Zoom, Rotate or Perspective 3D. Which methods of transformation can be applied depend on how many points you add to track.

5. Click the Add Tracker Point icon. A new tracker crosshairs appears in the Viewer in the center of the frame.
6 Move the pointer directly over the tracker crosshairs, and when it turns into the move cursor, click and drag to move the crosshairs to line up on top of the feature you want to track. For the best results, this should be a high-contrast detail such as a corner, the end of a line, a small shape like a pebble, or a jagged detail. Unlike other point trackers, there is no inside or outside region to separately adjust, there’s only the one crosshairs that you need to align. In this example, this first crosshairs is placed at the inside of her stage left eyebrow (the corner of her eye would introduce too much jitter as the tracker will pick up her blinks).

Lining up the tracker crosshairs with the feature you need to track

7 If you want to improve the accuracy of your track, you can create more tracker crosshairs and position them on top of other details within the subject you’re tracking. For the best results, make sure that all crosshairs are placed onto details that are in the same plane of motion. In other words, don’t put some crosshairs on a person’s face in the foreground, and other crosshairs on a tree that’s far in the background, since both these features will have very different vectors of motion. In this example, trackers are placed at her inside eyebrows and at the corner of her lips.

Setting up four trackers to follow the corners of her eyebrows and mouth

8 When you’re done placing crosshairs, click the Track Forward or Track Backward buttons to initiate tracking. The clip will be analyzed, and the Tracker graph will update with the tracking data, and the window you had selected automatically moves to match the motion of the feature you’re tracking.

The final track, accomplished with four point trackers, with the track path turned on
Removing Trackers

If you find that a particular tracker is causing problems, you can remove it by selecting it in the Viewer, and clicking the Delete Tracker icon, before retracking the subject.

Using Frame Mode to Offset Track

A common issue when point tracking is how to deal with occlusions and times when the tracked feature moves off screen. In DaVinci Resolve, the solution is to use the Tracker palette’s Frame mode to move the tracker crosshairs onto another feature to track, while offsetting the resulting motion so that it continues to follow the original motion path.

1 In this example, a point tracker crosshairs has been positioned at a corner of a window of a building that’s being separately adjusted using a Power Window. The window is being used because, as the woman turns to leave, she covers up most of the other trackable outer edges of the building, which would ruin the track.

2 As the camera pans, the feature being tracked is about to go off frame, which is about to ruin the track. As this happens, click the Stop Track button.

3 Move the playhead back to the last good frame of tracking, and then click the Frame button in the Tracker palette to go into Frame mode.
4 In Frame mode, you can now drag the tracker to another feature of the building, this time the outer edge of the roof, that will be better to follow as the building goes out of frame to the left, since the Power Window will go out of frame before the rightmost corner of the building’s roof does.

5 Now, click the Track Forward button again, and the crosshairs will begin tracking the new feature, but the motion will be offset, so the movement of the Power Window continues to follow the original motion path.

6 If you turn on the track path (in the Tracker Option menu), and move the playhead to the frame where you moved the tracker, you can see that the motion before you moved the tracker and the motion after continues smoothly along the same path, with no sudden breaks. When you're finished, click the Clip button to get out of Frame mode.
Rotoscopying Window Shapes After Tracking

While the DaVinci Resolve trackers are pretty miraculous when it comes to making a window follow moving subjects, or elements within a moving scene, there will be plenty of times when the final track isn’t quite perfect. For example, if you’re trying to isolate someone’s face with a very specific window, and the person turns their head, then the resulting change of shape is almost certainly going to require you to make animated adjustments to the window in order to continue making such a specific isolation.

Fortunately, the Tracker palette’s Frame mode makes it easy to animate shape changes you make to windows in order to better follow a moving subject, a task often referred to as rotoscoping. By following the motion of a moving subject, and making a series of automatically keyframed adjustments to the window at every point the subject changes speed or direction, you can make a window isolate a moving target with surprising precision.
Furthermore, you can also use Frame mode to repair imprecise tracks where the window is veering off course because of quickly or irregularly moving features. In these cases, you have the option of manually tracking the window in Frame mode to fit the trajectory of the feature, frame by frame.

Lastly, you don’t even have to have performed a track to use the Tracker graph in Frame mode to keyframe animated changes to a window. In fact, using the Tracker graph in Frame mode can sometimes be more convenient than using the Keyframe Editor in Auto Keyframe mode, depending on what you’re doing.

**Rotoscoping Controls**

The Clip/Frame buttons determine whether or not you’re rotoscoping a shape.

- **In Clip mode:** Any changes you make to a window transform it over the entire duration of that clip. In other words, you can track a window to a moving feature, and in Clip mode any changes you make to the size, rotation, position, or shape of the window occur equally from the beginning to the end of that clip.

- **In Frame mode:** Changes you make to a window automatically create a keyframe at the bottom of the ruler in the Tracker graph. Making two or more changes to a window in Frame mode results in automatically interpolated animation from one keyframed window transformation to the next.

You can freely move back and forth between Clip to Frame modes to make changes to a window. Even if you’ve keyframed a window to change shape, you can turn on Clip mode and make an overall change to the window, enlarging it for example, that results in the window being equally enlarged at every keyframe.

**Keyframing in Frame Mode**

Once you’ve added keyframes to the Tracker palette, there are a number of ways you can edit them.

**Methods of working with keyframes in the Tracker graph:**

- **To add a keyframe:** Click the Add Keyframe icon at the upper right-hand corner of the Tracker graph. It looks similar to the Keyframe icons found in the Edit page Inspector. This is useful for adding a keyframe to a frame where the window fits the subject well, prior to moving forward a few frames and making an alteration to the window to follow the subject that will generate another keyframe.

- **To move the playhead from one keyframe to another:** Click the Previous Keyframe and Next Keyframe icons at the upper right-hand corner of the Tracker graph. These controls look similar to those found in the Edit page Inspector.

- **To delete a keyframe:** With the playhead on the same frame as the keyframe you want to delete, open the Tracker option menu, and choose Delete Keyframe.

**A Rotoscoping Workflow**

The following procedure demonstrates how to use a window to rotoscope an onscreen feature that you want to isolate. In the process, it shows how to set up a window for rotoscoping using the Tracker palette, and discusses some best practices for rotoscoping efficiently.
To rotoscope or manually track a window using automatic keyframing:

1. Create a window to isolate the feature you’re wanting to adjust, and use the tracker to make it follow the motion of the subject. If the window doesn’t follow the contours of the subject as precisely as you require, then you can begin manually keyframing its shape on top of the tracking you’ve done to rotoscope the subject.

2. With the Tracker palette open, click Frame to change the tracking mode.

The best way to use Frame mode for tracking is to either start at the last successfully tracked frame and work your way forward, or start at the first successfully tracked frame and work your way backward. This takes the best advantage of the automatic keyframing and interpolation between keyframes to animate the window you’re transforming smoothly.

3. With the playhead at either the first or last frame where the window fits the subject you’re isolating, you can either click the Add Keyframe button at the upper right-hand corner of the Tracker graph, or wiggle any control point by a pixel or two, to add a keyframe at that frame.

Adding a keyframe at the last frame where the window follows the subject’s motion well means that any future animated changes you make interpolate from this frame forward, rather than from previous frames where there’s no need for alterations.

While you’re in Frame mode, the changes you make to the window automatically generate a keyframe in the Tracker palette, which appears at the bottom of the Tracker graph’s timeline.

It’s frequently essential to add a keyframe at the last frame where a window conforms well to the subject you’re trying to isolate, in order to limit window animation from that frame to the next keyframed transformation, rather than accidentally animating from the beginning of the clip, or from the next or previous keyframe in the Tracker graph.
4 Next, move the playhead to the next frame where the window requires adjustment to better fit the moving subject, and adjust the position of the window, the control points of the window, or both to isolate the subject as necessary.

Readjusting the window in Frame mode to follow the subject’s motion

This results in a second keyframe being placed in the ruler of the Tracker graph.

Two keyframes creating rotoscoped animation in addition to any motion tracking that’s applied

5 With your first two keyframes placed, scrub the playhead back and forth between them to evaluate how well the window’s animation is automatically interpolating to fit the motion of the subject you’re isolating. If the window doesn’t follow the motion of your subject well enough, move the playhead to the frame where the window divergence is the most pronounced and make another adjustment to correct the shape.

A frame between the two keyframes you’ve rotoscoped that needs further adjustment

This creates another keyframe.

After adjusting the in-between frame
When you’re finished making adjustments between your first two keyframes, move the playhead farther along and add keyframes as necessary to make the window follow the motion of your subject.

In general, look for the frames where your subject’s motion starts, stops, speeds up, slows down, or changes direction. As you work, it’s good to try and add the fewest number of keyframes you can to ensure smooth motion from one to another. Too many keyframed adjustments made too close together for a smoothly moving subject risks adding jerky motion if you’re not careful. On the other hand, if you have an erratically moving subject, you may have to add more keyframes, possibly frame by frame, to achieve the desired result.

**TIP:** If you’re isolating a subject with a complex shape that moves quite a lot, you might consider using multiple simple overlapping shapes to track and rotoscope it, rather than a single complicated one, to make the task easier.

When you’re finished rotoscoping the window, be sure to click the Clip button to switch back to Clip mode, so you can trim the window’s shape across every keyframe you’ve just created, if necessary. This will also prevent you from accidentally adding more keyframes if you select other shapes.

This technique requires a bit more work than simply using the Tracker, but it’ll let you quickly adjust the animation of a window to more tightly conform to a moving subject when you need an adjustment to be specific to that subject alone. You can also use this technique to reposition specific motion path points in the middle of an otherwise successful track to make them fit better, or to add keyframes to the beginning or end of a track when the subject moves offscreen but the window does not.

**Viewing a Window’s Motion Path**

You can turn on the motion path of the window you’re tracking by choosing Show Track from the Tracker Option menu.
The Gallery provides a way to save, browse, and use saved still frames from different clips in a program. Each project is saved with its own individual set of stills, and each still you save consists of a DPX image of the saved frame, and the grade metadata. You can use saved stills for reference when matching one clip to another, or you can use them to copy grades to other clips, or other timelines.

There are two ways to work with the contents of the Gallery. The Color page has a small Gallery, to the left of the Viewer, that provides quick access to saved stills and grades as you work. The Gallery window, which can be opened via a button at the top right of the Gallery, provides a dedicated interface for organizing your grades, copying grades and memories between projects, and for accessing a dedicated collection of DaVinci Resolve looks.

**Contents**

- Using the Gallery 2742
- Saving Stills 2742
- Selecting Stills 2743
- Deleting Stills 2743
- Where are Stills Saved? 2744
- Changing the PowerGrade Still Directory 2744
- Live Previews of Gallery Stills 2744
- Hover Scrub in the Gallery 2744
- Playing Stills and Setting Up Image Wipes 2745
- Timeline Wipes 2746
- Gang Timeline Wipe With Current Clip 2746
- Change a Timeline Wipe Using the Timelines Album of the Gallery 2746
- Labeling and Searching for Stills and Sources 2746
  - Automatic Labeling 2746
  - Manual Labeling 2747
  - Searching For Stills 2747
  - Match Reference Wipe Frame 2748
Using the Gallery

The Gallery in the Color page and the expanded Gallery window environment share many of the same commands for organizing stills. However, the commands for saving stills and customizing split-screen views are restricted to the Color page.

Saving Stills

One of the most common operations is to save a clip as a still (with that clip’s embedded grade) for future reference and use.

To save an individual still in the Color page, do one of the following:

- Choose View > Stills > Grab Still (Option-Command-G).
- Right-click on the Viewer and choose Grab Still.
- Press GRAB STILL on the Transport panel of any of the DaVinci Resolve control panels.

It’s also possible to save stills automatically for every clip in the entire Timeline. This can be useful if you’re planning to export a set of grades to hand off to another colorist, or if you need to apply a series of grades manually from one project to another when ColorTrace™ won’t work.
To save a still for every clip in the current timeline, right-click the Viewer, and choose one of the following:

- **Grab All Stills > From First Frame**: The first frame of each clip is saved to the Gallery.
- **Grab All Stills > From Middle Frame**: The middle frame of each clip is saved to the Gallery.
- **Grab Missing Stills > From First Frame**: Only the first frame of clips with no stills in the Gallery are saved to the Gallery.
- **Grab Missing Stills > From Middle Frame**: Only the middle frame of clips with no stills in the Gallery are saved to the Gallery.

By default, when you save one or more stills, they’re named “TrackNumber.ShotNumber.VersionNumber” with dots separating each number. If you like, you can choose an option from the General Options panel of the Project Settings to “Automatically label Gallery stills” in different ways. This is covered in more detail later in this chapter.

### Selecting Stills

To select a range of stills, do one of the following:

- Click one still, then Shift-click another to select a contiguous range of stills.
- Command-click any stills you like to make a noncontiguous selection.
- Right-click any still, and choose one of the following commands;
  - **Select All**: Selects every clip in the Gallery.
  - **Select Current to Last**: Selects every still from the one you’ve clicked through the last still in the Gallery.
  - **Select First to Current**: Selects every still from the one you’ve clicked through the first still in the Gallery.

### Deleting Stills

If you need to remove one or more stills, this can only be done using the Gallery’s contextual menu.

To delete one or more stills, do one of the following:

1. Select one or more stills in the Gallery.
2. Right-click one of the selected stills and choose Delete Selected.

Each still is also saved with a variety of metadata that is used by DaVinci Resolve to manage the contents of the Gallery in different ways. This metadata can also be used for searching and sorting, and is viewable by opening the Still Properties window.

To display a still’s properties:

- Right-click a still in the Gallery and choose Properties.

A floating translucent window appears displaying the date the still was created, what clip it was grabbed from, when it was grabbed, and the source and record timecode values of the frame it came from.
Where are Stills Saved?

By default, all grades/stills you save are saved in the DPX format, and are placed in the directory path defined in the “Gallery stills location” field in the Working Folders section of the Master Settings panel of the Project Settings. This path defaults to a hidden “.gallery” directory that’s created at the location of the first Media Storage Volume you specify in the Media Storage panel of the System Preferences window.

Changing the PowerGrade Still Directory

Optionally, you can change the location where PowerGrade stills are saved by Opening the Gallery Option menu and choosing Change PowerGrades Path. You’ll be prompted via a “Select PowerGrades Folder” dialog to choose a directory where all PowerGrades will be saved.

Live Previews of Gallery Stills

The Live Preview option, found in the Gallery option menu, lets you preview how the current clip would look with a particular Gallery Still grade applied to the currently selected clip simply by moving the pointer over the still you want to preview.

Enabling and Disabling the Gallery Live Preview:

1. Open the Gallery option menu and choose Live Preview.

2. Click a node in the Node Editor you want to preview applying the grade from a still to. The live preview will display how the current clip will appear with the grade of the still you select applied to the currently selected node of current grade, which will affect the result.

3. Move the pointer over the still you want to preview.

   The Viewer image updates to show how that clip would look with that still’s grade applied to the currently selected node.

Hover Scrub in the Gallery

When Live Preview is enabled in the Gallery option menu, the Hover Scrub Preview submenu lets you choose how you want Live Preview to be shown by a thumbnail in the Gallery and in the Viewer when you hover the pointer over a still or LUT in the LUT Browser:

- You can choose to scrub both the thumbnail you’re hovering over and the Viewer, letting you preview the current still’s grade or a LUT over the duration of the current clip in both the thumbnail and Viewer.
- You can choose to scrub just the thumbnail, leaving the Viewer to show just the grade or LUT over the frame at the position of the playhead.
- You can disable scrubbing altogether, in which case both the thumbnail and the Viewer will only show the grade or LUT over the frame at the position of the playhead.
Playing Stills and Setting Up Image Wipes

There are many ways to play a still in the Color page, making it visible as an image wipe in the Viewer and on the external display connected to your video interface.

To play a still, displaying it as an image wipe or full screen, do one of the following:

- Double-click a still in the Gallery.
- Select a still in the Gallery, and click the Image Wipe button on the top Viewer toolbar.
- Click a still in the Gallery, then right-click in the Viewer and choose Show Reference Wipe.
- From the View > Stills menu, choose Next Still (Option-Command-N) or Previous Still (Option-Command-B) to select a still in the Gallery, and then choose Wipe On/Off (Command-W) to play it.
- Press PREV STILL or NEXT STILL on the DaVinci Resolve Advanced Search Dial panel, or the DaVinci Resolve Advanced control panel to select a still, then press PLAY STILL. Press PLAY STILL again to dismiss the still.

Whenever you play a still, the Viewer mode’s drop-down menu changes to Split mode.

Once displayed, the wipe between the current clip and the still being referenced can be moved and reoriented in different ways. If you want a full-screen view so you can flip back and forth between the still and the current clip, simply adjust the split until the still fills the entire Viewer.

To adjust a wipe in the Viewer, do one of the following:

- Drag the pointer within the Color page’s Viewer to move the wipe.
- Push the T-bar lever up and down on the T-bar panel of the DaVinci Resolve Advanced control panel.

To customize the type of image wipe that’s displayed in the Viewer, do one of the following:

- Click any of the controls at the top right of the Viewer toolbar to choose Horizontal, Vertical, Mix, Alpha, Box, and Difference types of wipe.
- Choose Gallery, Timeline, or Offline from the View > Reference Wipe Mode submenu, or the Viewer contextual menu.
- Choose Horizontal, Vertical, Mix, Alpha, Difference, and Box from either the View > Wipe Style submenu, or the Viewer contextual menu.
- Choose View > Invert Wipe (Option-W), or right-click the Source Viewer and choose Invert Wipe from the contextual menu to reverse each half of the wipe.
Timeline Wipes

A timeline wipe is when you use the Wipe Timeline Clip command in the Thumbnail timeline (it’s found in the contextual menu when you right-click a clip other than the current clip) to wipe the current clip against another clip in the Timeline, without needing to save a still first. When you turn a timeline wipe on, the clip in the timeline that’s being wiped is outlined in blue.

Gang Timeline Wipe With Current Clip

A “Gang timeline wipe with current clip” option, available from the Viewer option menu, lets you maintain the offset between the current clip and a timeline clip you’re wiping against when you move the current clip selection to other clips. With this option enabled, the offset between the timeline wiped clip and the current clip is maintained when you move the clip selection. When this option is disabled, the timeline wiped clip stays where it is regardless of what clip you select.

Change a Timeline Wipe Using the Timelines Album of the Gallery

While you’re using the Wipe Timeline Clip to show a wipe of the current clip against any other clip in the Timeline, you can open the Timelines album of the Gallery and click different clips to change which Timeline clip you’re wiping against (outlined in blue) without changing the current clip (outlined in orange). Make sure you have selected the same timeline in both the Timeline album, and the Color page.

Labeling and Searching for Stills and Sources

By default, all stills are identified by a three-number code. The first number is the video track the clip is on, the second number is the clip’s position number in the current Timeline, and the third number is the version number of the grade.

If you’ve saved many stills, it can help to label the important ones with whatever text you find helpful. Once labeled, you can search for stills by label using the Search field, at the upper right-hand corner of the Gallery.

Automatic Labeling

If you like, you can choose an option from the Color group in the General Options panel of the Project Settings to “Automatically label Gallery stills” in different ways. There are many options:

– **Clip Name**: Saves the Clip Name, which defaults to the File Name unless you’ve customized it.
– **Clip Version Name**: Automatically saves the name of the current version.
- **Source timecode (HH.MM.SS.FF):** Saves the source timecode of the current frame.
- **Timeline timecode (HH.MM.SS.FF):** Saves the timecode for the playhead's position in the Timeline.
- **Timeline Name:** Saves the name of the currently open Timeline.
- **Display LUT Name:** Saves the name of the currently used Display LUT, if one is applied.
- **Custom label using tags:** Choosing this option reveals a field you can use to either type custom text into, or in which you can use metadata variables to save automatically updated information relating to the currently selected clip and timeline. For more information about using metadata variables, see Chapter 15, "Using Variables and Keywords."

For all options, there’s also a checkbox you can toggle:

- **Append still number on export:** Turning this checkbox on lets you choose how to include the default still number when exporting stills with the “Use labels on export” option enabled, either as a prefix or suffix.

### Manual Labeling

Sometimes the easiest thing to do is to just give a particular still a custom name that’s representative of what that still represents, such as “SeemedLikeAGoodIdea.” When naming stills manually, it’s best to avoid using the forward slash character in case you find yourself exporting these stills with file names. In fact, it’s a good idea to avoid using the forward slash character for just about any text that you add in DaVinci Resolve.

**To manually label a still:**
1. Right-click a still in the Gallery and choose Change Label or double-click directly under the Still ID.
2. Type a name into the Change Still Label dialog, and click OK.
   - The new label appears underneath the still number.

You can also label stills for easier identification.

### Searching For Stills

Once labeled, you can search for stills you need in the Gallery.

**To search for a still by label:**
- Click the Magnifying Glass button to open the Search field, click to place the cursor within, and then type the name or description you are searching for.

As soon as you start typing, DaVinci Resolve automatically begins to filter the results of the currently selected album in the Gallery to match what’s been typed.
Match Reference Wipe Frame
You can right-click any Gallery still and choose Match Reference Wipe Frame to automatically move the playhead to the exact frame that corresponds to that still, and select that clip in the Color page Timeline.

Gallery Options
In the upper right corner of the Gallery palette there are several options that let you adjust the view and organization of your stills.

– **Still Size Slider**: Dragging this slider to the left makes the still thumbnails smaller, dragging it to the right makes them larger.

– **Sort Stills**: Choosing an option from this submenu changes the sort order of all clips in the Gallery. The options are:
  – **Still ID**: Sorts all stills by their assigned ID number (track, clip number, grade version).
  – **Label**: Sorts all stills by their text label.
  – **Record Timecode**: Sorts all stills by their position in the program.
  – **Source Timecode**: Sorts all stills by the timecode of the source clip they came from.
  – **Grab Date**: Sorts all stills by the date they were originally grabbed.
  – **Create Time**: Sorts stills based on when you saved each still.

– **Thumbnail View**: Pressing this icon puts the gallery in Thumbnail view; each still is represented by an image.

– **List View**: Pressing this icon puts the gallery in List view; each still is represented by columns of text attributes.

– **Search**: Opens up a search dialog box, to find stills based on their text label.

– **Gallery View**: Opens up the full Gallery Management window.

When you right-click the gray area of the Gallery, behind the Still icons, you can open a contextual menu that provides a variety of additional options for controlling how many stills are saved, how they’re displayed, and how they’re arranged in the Gallery. There are the following options:

– **Switch Wipe Mode**: Switches the Reference mode between showing a “Gallery” still, a “Timeline” clip, or an “Offline” reference movie.

– **Trace Timeline**: When enabled, selecting a clip in the Timeline also automatically selects the first still that was saved from that clip to the Gallery.

– **One Still Per Scene**: When enabled, restricts the Gallery to save only a single still for each clip in the Timeline. If multiple stills have already been saved before turning this option on, those stills will remain in the Gallery until you save another still from the same clip, at which time all other stills from that clip will disappear.
– **Apply Display LUT**: If you have a Display LUT selected in the Lookup Tables panel of the Color Management panel of the Project Settings, it’s applied to the video output via a connected video interface, and also to the Viewer. Ordinarily, you don’t also want the Display LUT applied to stills you’re saving since it’s meant to be temporary. Accordingly, stills are saved with a LUT-free image. However, in instances where you may also want to save a reference to the currently used Display LUT, turning on “Apply Display LUT” saves the Display LUT along with the still, and applies that LUT when that still is used for split-screen reference. Keep in mind that the internally saved Display LUT is only used when playing that still in the Viewer; the DPX image that’s saved remains unaffected.

– **Apply Grades Using**: This submenu contains three options for how to apply the keyframes that are automatically saved within each saved grade.

  – **No Keyframes**: No keyframes are copied. The state of the grade at the frame used to save the still is what is applied to the target clip or clips.

  – **Keyframes Aligning Source Timecode**: Keyframes are copied aligning the source timecode of the saved grade with the source timecode of the target clip. This is the ideal setting when you’re copying a grade back to the clip it came from originally, or to a duplicate of that clip elsewhere in the Timeline, and you want the keyframes to align with the same frames as before. If there is no source timecode overlap, keyframes will be pasted aligning with the start frame of the edit, the same as the third option (below).

  – **Keyframes Aligning Start Frames**: Keyframes are copied aligning the start frame of the clip that still was saved from with the start frame of the target clip. This is the ideal setting when you’re copying a grade with keyframes from one clip to a completely different clip, with different timecode.

– **Use labels on still export**: Lets you use labels that you’ve added to stills in the file name of exported stills.

– **Show All Stills**: This command shows all available stills in the current album if any have been hidden, for example by searching or by using the Show Current Timeline Only command.

– **Show Current Timeline Only**: Choosing this option restricts the Gallery to only showing the stills that were saved from the currently selected Timeline. All other stills from other Timelines are hidden until you switch to that Timeline.

**NOTE**: There are a variety of other commands available in this contextual menu that are covered elsewhere in this chapter.

### Organizing Stills Using Albums

All stills you save are always placed into the currently open album of the Gallery, which defaults for new projects to “Stills 1.” However, you can create additional albums with which to organize your stills into whatever categories you require. Albums can be shown, created, and removed using the Gallery in either the Color page or Gallery windows.
To show or hide the Albums list:
– Click the Album button, at the top left of the Gallery.

If the Albums list was hidden, clicking the Album button will make the Albums list appear, to the left of the Gallery, containing all albums that are currently available in the project that’s open, as well as the PowerGrade album at the bottom. If the Albums list is already visible, then it becomes hidden, making more room for still thumbnails in the Gallery.

Once you’ve displayed the Albums list, there are a variety of ways you can quickly and easily work with albums.

Methods of working with albums:
– To add a new album: Right-click the Albums list, and choose Add Still Album from the contextual menu. A new album is created, numbered incrementally.
– To add a new PowerGrade album: Right-click the Albums list, and choose Add PowerGrade Album from the contextual menu. A new album is created, numbered incrementally.
– To rename an album: Double-click any album in the list, and when it is selected, type a new name and press Return.
– To navigate albums: Click any album to make it the current album. Using the DaVinci Resolve Advanced control panel, you can use the PREV PAGE/NEXT PAGE buttons to move up and down the Album list.
– To move clips from one album to another: Drag and drop a still from the Gallery to an album.
– To remove an album: Right-click any album, choose Remove Current Album, and click Delete at the prompt. All clips inside that album will be deleted along with the album, so use this carefully.

PowerGrade Albums

PowerGrade albums are meant to be repositories for grades you want to reuse frequently, or for stills that you need to reference from multiple projects, such as when grading a series that shares common looks from episode to episode.

Unlike stills saved to the other albums in the list, which are ordinarily available only to the project in which they were saved, stills saved to a PowerGrade album are shared among all projects that have been stored within a particular database. Each database has its own unique PowerGrade album.
Creating a new database creates a new PowerGrade album, which starts out as a clean slate. However, you can always use the Gallery window to copy PowerGrade stills from other projects and databases to the current one, and you can create as many PowerGrade albums as you need to organize your grades. For more information about project management and databases, see Chapter 3, “Managing Projects and Databases.”

Functionally, PowerGrade albums are identical to any other album, and you can save, organize, and use stills in PowerGrade albums as you would with other albums. Since PowerGrade albums are special in that they’re maintained by DaVinci Resolve, the last PowerGrade album cannot be deleted.

**Browse all Grades from the Current Timeline**

The Gallery has a Timelines album, available at the bottom of the Album list, that lets you browse all the grades in the current timeline, or in other timelines of the current project (using a drop-down menu that appears at the top of the Gallery browser area), making it easy to copy grades from earlier or later in your timeline, or from other timelines that share the same media.

This is particularly useful for reality shows or documentaries where the same clips can appear multiple times in different parts of a program. Being able to simply show all existing grades in the Gallery frees you from having to save a still for every grade you think you might eventually reuse.

The Timelines grade browser in the Gallery automatically shows all grades in the current timeline

**The Gallery Management Window**

While you can do quite a lot of stills management using the Gallery as it appears in the Color page, the Gallery window provides additional functionality for copying stills among different projects and databases, for organizing your stills and memories, and for accessing the DaVinci Resolve looks that accompany the application.

To open the Gallery window:

– Click the Gallery View button at the upper right-hand corner of the Gallery or select Workspace > Gallery.
The Gallery opens into a floating window, divided into four areas:

- **Stills navigator**: Lets you navigate the contents of other projects and databases that are available. Independent projects, as well as database > user > project relationships, appear in this hierarchical list. Click the disclosure triangle next to any item on this list to reveal its contents. Click any project in the list to reveal its albums and stills in the Group Stills browser.

- **Group Stills browser**: Displays the contents of the currently selected item in the Stills navigator. One or more selected stills can be copied to the current project by selecting an album in the Project Stills browser, and dragging and dropping the selected stills to the Project Stills browsing area.

- **Project Stills browser**: Contains the same Album list and Project Stills browser that’s visible in the Color page Gallery.

- **Project Memories**: Provides a larger view of the project memories that are visible in the Color page Gallery.

**To resize different areas of the Gallery window:**

- Move the pointer to the border between any areas of the Gallery. When the pointer changes to the resize cursor, drag the border to resize the adjacent interface areas to whatever size you need. Dragging all the way to the edge of the screen hides that interface area completely.

**What’s Available in the Stills Navigator**

The Stills Navigator accesses a variety of content via a hierarchical list. Disclosure triangles to the left of each item in the Stills browser let you access the contents of each item, and many items have several nested levels of content within, each accessed by its own disclosure triangle.
The Gallery Stills database show all projects connected so you can import those stills – DaVinci Resolve looks: A collection of predefined grades, categorized by type, that provides excellent examples of different looks available in DaVinci Resolve. These grades are installed with DaVinci Resolve and cannot be altered.

– Databases: Each database that’s available appears within this list. Each database has a nested series of users, projects, and timelines within, as well as one nested PowerGrade item for each user, which provides access to the saved stills within.

– Orphans: Stills are saved to a separate directory which is defined in the Master Settings panel of the Project Settings. Whenever you delete a database, the stills that corresponded to that database become orphaned. All orphaned stills that lack a connection to any current database appear within the Orphan item in the Stills Navigator.

Browse and Import Timeline Grades From Other Projects

The Gallery window lets you see and import grades in the timelines of other projects, even if they weren’t saved as stills first. When you open the Gallery Window and use the hierarchical disclosure controls of the Stills panel to open up and select a specific Database > User > Project > Timeline, you’ll see at least three browsable albums to the right: the Stills galleries that were created, the Memories, and at the bottom an album called Timeline Media. The Timeline Media album lets you browse the currently used grades for every clip in that timeline, making it easy to copy the ones you need to the current project’s Stills album or Memories.

This is particularly useful if you’re working on a series where and you find that you want to re-use different grades, looks, adjustments, or fixes from previous episodes in the current one. Previously, you’d have to remember to save every clip as a still to be able to browse the grades in this way. Now you can simply browse the clips in the Timeline directly.
Importing and Exporting Stills

It’s possible to import still images in different graphics formats into the Gallery, which can be particularly useful when a client provides reference images to which they’d like you to refer. It’s also possible to export stills from the Gallery, which is good for sending a series of reference stills for approval to a remote client. In both cases, you can choose whether to import or export images with an accompanying LUT.

For both import and export, DaVinci Resolve supports the following file formats: DPX, CIN, TIFF, JPEG, PNG, PPM, BMP, and XPM.

To import one or more still images:

1. Right-click anywhere on the gray background of the Gallery.
2. Choose one of the following commands:
   - **Import**: Imports image files, along with a matching DRX file, if one is present in the selected directory.
   - **Import With Output LUT**: Imports an image and DRX file, along with a matching LUT file, if one is present in the selected directory.
3. When the Import Stills dialog appears, choose the type of files you want to import from the “Files of type” drop-down menu, then navigate to the files you want to import, select them, and click Import.

To export one or more still images:

1. If you want to export Gallery stills with labels that have been added to them, right-click anywhere in the background of the Gallery and choose “Use labels on still export” in the contextual menu so it becomes checked.
2. Select one or more stills in the Gallery.
3 Right-click one of the selected stills, and choose one of the following commands:
   – **Export**: Two files are saved for each still you selected. An image file in the format of your choice, and a DRX (DaVinci Resolve eXchange) file that contains the grading metadata that was saved with that Gallery still.
   – **Export With Display LUT**: If you have a Video Monitor Lookup Table specified for the current project in the Color Management panel of the Project Settings, this command will output the image as it is processed by the specified LUT. A DRX file is also output containing the grading metadata that was saved with that Gallery still.

4 When the Export Stills dialog appears, choose a file format to export to from the “Files of type” drop-down menu, then choose a location, type a name into the Save As field, and click Save.
   Each of the selected stills is exported with all accompanying files. Each file uses as its prefix the name you typed into the Export Stills dialog, followed by an underscore, the still ID number of the selected still, and the three-letter file extension.

### Using and Organizing Memories

Stills and memories contain identical information, and can be split screened, copied, appended, exported, and can display their node graph just like any other still. However, stills that are assigned as a memory make them easier to access via keyboard shortcuts, and from dedicated buttons on the DaVinci control panel.

Memories are hidden by default, but you can reveal them by clicking the Memories button, to the right of the Gallery list button at the top-left of the Gallery.

![Place grades you will use often in Memories for faster recall](image)

The Memories thumbnail display makes it easy to keep track of which stills have been assigned to which memories in situations where you’re using multiple memories to copy grades throughout a program.

**To copy stills and memories back and forth, do one of the following:**

– Drag a still onto a memory bank.
– Drag a memory into the Gallery.

**TIP**: In this way, memories can be used to copy stills from one album to another.
To save the current clip's grade to a memory for future use, do one of the following:

- Choose Color > Memories > Save Memory A–H (Option-1 through 8).
- Using the DaVinci Resolve Advanced control panel, press CRNT on the Search Dial panel, then press the letter of the memory bank you want to save to. Use the SHIFT UP and SHIFT DOWN buttons to save to another memory sharing the same button.
- If you save a grade to a memory that already contains something, the previous memory is overwritten.

To apply a memory to the current clip in a timeline, do one of the following:

- Right-click a memory and choose Apply Grade.
- Choose Color > Memories > Load Memory A–H (Command-1–8).
- Using the DaVinci control panel, press the letter of the memory bank you want to apply. Use the SHIFT UP and SHIFT DOWN buttons to apply a memory that shares the same button.

To clear a memory:

- Right-click a memory, then choose Clear.
Chapter 139

Grade Management

The Color page offers numerous ways of saving grades, copying grades, creating and altering groups of clips to share grades, rippling grades and adjustments, and managing multiple versions of grades. All of these procedures enable you to work faster by leveraging work you’ve already done to apply to other clips that can benefit from the same adjustments, or by applying changes across multiple clips all at once.

Contents

Using Versions to Manage Grades
Choosing to Copy Grades Manually or Automatically Using Versions
Using Local Versions by Default
Using Remote Versions to Enable Automatic Linking
Working with Versions
The Importance of “Version 1”
Deleting Unused Versions
Rendering Versions

Copying Grades
Protecting Adjustments with the Copy Grade Options
Copy and Paste From One Clip to Another
Copy and Paste Specific Parameters Using Paste Value
Applying Saved Grades From the Gallery
Preparing to Copy or Apply Grades
Copying Grades Using the Pointer
Copy Forward Commands
Copying Using Memories
Copying Using Preview Memory
Copying from Stills in the Gallery
Append Node Graph
Aligning Keyframes to a Specific Frame While Copying Grades
Using Versions to Manage Grades

Working quickly requires a mastery of the numerous grade management features built into DaVinci Resolve. These features are designed to help you copy and ripple grades to individual clips, among manually defined groups of clips via the Node Editor’s Clip mode, or among automatically linked clips that share the same source clip in the Media Pool (when using Remote versions). Multiple versions of grades are supported for every clip, as are various options for previewing, overwriting, and appending these versions.

Choosing to Copy Grades Manually or Automatically Using Versions

Each grade you apply to a clip is a version. Each clip can have multiple versions, although only one version can be applied at a time. By default, the first grade applied to every clip in a timeline is a local version named “Version 1.” A clip’s version name and/or number appears underneath the clip thumbnail, to the right. You can also see the version name, along with a list of all the other versions that are currently available to that clip, by right-clicking a clip in the Timeline and looking for the version names that appear underneath the Local Versions submenu.
NOTE: Double-clicking the version name underneath a clip’s thumbnail in the Timeline cycles the version names, the clip names, and the codec used by each clip.

There are two different types of versions in DaVinci Resolve, each of which provides a different method of grade management and linking among the clips and timelines of a project.

- **Local versions**: The default mode of grade management. Clips using local versions are unlinked, so each clip has its own grade which is not shared with any other clips in any other timelines. Changing the grade of a clip using a local version has no effect on any other clip in that project.

- **Remote versions**: An alternate mode of grade management that you can enable. All clips using remote versions that share the same source clip in the Media Pool are automatically linked, in all timelines, and share the same set of grades.

If you use local versions to grade all your clips, you don’t have to worry about one clip’s grade being accidentally copied to other clips that happen to come from the same file in the Media Pool, which can make it easier to work. On the other hand, you need to manually copy every grade that you want to duplicate, even among clips that clearly come from the same take or angle. You can always create a group to share a grade among clips using local versions, but that’s an extra step.

Switching to use remote versions, instead, puts you into a mode where clips using remote versions that share the same media file are automatically linked together. This gives you a convenient shortcut for grading your program, since a grade that’s applied to one linked clip is automatically copied to every other clip it’s linked to, which can be convenient when grading a series of headshots appearing throughout a program that come from the same interview take. Another use of remote versions is when you’re importing a new edit of an already graded timeline. Using remote versions, you can set your project up so that new incoming timelines are automatically relinked to the previous timeline’s grades.

The only disadvantage to using remote versions is that when you find you need to make individual adjustments to clips that are linked, it’s an extra step to either create another version, or switch that clip to use a local version, in order to keep its adjustment separate. This will be discussed in more detail later in this chapter.

**Mixing Versions**

Each clip is capable of having multiple local and remote versions at the same time; you get to choose which to apply. Which type of versioning is best depends on the type of project you’re working on, the way in which the media was shot, and how you like to work. The following sections explain the differences in workflow.

**Using Local Versions by Default**

Since local versions are the default method of grading when you first create a new project (unless you’ve edited your settings presets), you don’t need to do anything to enable this mode at first. As the name implies, local versions are local to the Timeline in which they appear, so local versions are not rippled to linked clips, and they’re not shared among different timelines. This makes it easy to avoid accidentally having grades copied when you don’t want them to be, but you lose the conveniences that automatic linking can provide.

However, you can always switch the clips in a timeline to use remote versions if you change your mind, either individually, or all together.

**Using Remote Versions to Enable Automatic Linking**

Remote versions let all clips from the same source media file in the Media Pool share their grades automatically, either within a single timeline, or across multiple timelines in the same project. However, to enable the convenience of remote grades, you need to put DaVinci Resolve into this mode of working using the Settings window.
To enable remote grades to be used:

– Open the Project Settings, open the General Options panel, and turn off “Use local version for new clips in timeline” in the Color section.

Turning this option off only affects clips that are added to Timelines from that point onward. You can keep track of which clips use remote versions by the (R) that appears when you double-click the area underneath the thumbnail to hide the codec name in the Thumbnail timeline.

How Automatic Linking Works

When clips using remote versions have been added to a timeline, any other clips in any timeline that (a) use remote versions also, and (b) refer to the same file in the Media Pool are linked. Selecting a clip using a remote grade in the Color page that is automatically linked to one or more clips displays a small “linked” badge at the right of that clip’s timecode in the Thumbnail timeline.

TIP: The Timeline Filtering drop-down in the Color Page toolbar has an option named “Common Media Pool Clips” that only shows clips in the Timeline that are linked to the currently selected clip.

Adjustments that you apply to a remote version of one linked clip are automatically rippled to every other clip it’s linked to, which can save you an enormous amount of time when you’re getting started with a new program. For example, if every reverse angle from the same take in a particular angle of coverage is automatically linked using remote versions, then the grade you apply to one reverse angle clip will ripple to every other reverse angle clip throughout the Timeline.
So long as remote versions are enabled, there are other ways that linked clip relationships are formed. If, after conforming an AAF, XML, or EDL, you used the Split Clips button in the Color page to split one conformed clip into many, each of the clips you split would be linked, since they too would share the same source media in the Media Pool.

Finally, automated linking also occurs for clips that appear in multiple timelines that also use remote versions. As a result, the grade you apply to one linked clip is automatically rippled to every other clip it’s linked to.

**NOTE:** Media management or media consolidation operations that split large source media files into many individual media files will defeat automatic linking within the same timeline, since each clip will be conformed to its own individual media file.

### Starting with Remote Versions, Then Switching to Local Versions

It's possible to combine the best aspects of remote and local versions into a single workflow, taking advantage of your ability to freely switch from one to the other. Since remote versions make it easy to copy grades among clips that are similar, you can switch to using remote versions first, and then grade your way through the Timeline until you get to the point where you need to start making much more specific changes to individual clips. Then, it’s easy to either switch each linked clip that needs individual adjustment to use a local version, or to use the Copy Remote Grades To Local command (described later) to copy the current remote version of each and every clip to a local version, at which point you can make all the specific tweaks you need to without worrying about changes being accidentally copied.

### Creating a Master Timeline

DaVinci Resolve version 9 and earlier would automatically create a Master Timeline whenever you added clips to the Media Pool. This changed in versions 10 and later, which by default have no Master Timeline. However, if you want to create a Master Timeline in order to use it as you would have before, this is easy to do.

If you want a Master Timeline to have a single timeline that always contains all clips currently in the Media Pool, there’s a way you can create one. However, you need to do it immediately upon creating a new project, before adding any media to the Media Pool. Once you’ve added one or more clips to the Media Pool, the option you need to do so will be disabled.

**To create a new Master Timeline:**

1. Create a new project, open the General Options panel of the Project Settings, and turn on the “Automatically match master timeline with media pool” checkbox in the Color section. If you also want all clips to use Remote versions as you grade by default as in previous versions of DaVinci Resolve, you can turn off the “Store grade with local version by default” checkbox.

2. Click Save.
Open the Edit page, and choose File > New Timeline (Command-N).

When the New Timeline Properties window appears, turn the Empty Timeline checkbox off, and click Create New Timeline.

Now, in addition to the new Timeline, a Master Timeline appears in the Timeline list.

Once created, the Master Timeline contains every clip in the Media Pool of the current project. If you color correct the clips in the Master Timeline, you'll find there's only one set of versions available, found underneath the Local submenu of the Color Page timeline's contextual menu. It's important to understand that local versions within the Master Timeline are in fact the remote versions found in every other timeline of that project.

In fact, it would be fair to say that the remote versions found in other timelines are actually the Master Timeline's versions. When you grade a clip in the Master Timeline, those grades ripple out to every other instance of that clip, in every other timeline within that project, via remote versions.

Sharing of remote versions among the Master Timeline and newly conformed timelines is why you can grade a collection of clips that you import into DaVinci Resolve without any editorial structure, grade and output offline media, and then reimport a project file that relinks to the original clips along with their grades. It's also why you can grade clips in one timeline, and then import additional re-edited timelines via AAF, XML, or EDL, which automatically inherit all remote versions of grades that were created in previous timelines.

Differentiating Clips with Individual Versions

If you've enabled DaVinci Resolve to add clips with remote versions, there are times when you may want to suspend automatic linking. As convenient as automatic grade rippling among linked remote versions is, there are many instances where you may need to stop it. For example, if the Media Pool contains a source media file with the entire content of an interview, then every clip that has been conformed to that source media will be linked, which is ordinarily good since you'd expect they'd all share the same grade. However, if the DP fiddled with the exposure of the camera in the middle of the interview, such that some clips are lighter and others are darker, you may find yourself needing to make different adjustments to clips from different parts of the interview.

One way of doing this, which can be useful in timelines where you only need to make a few of these kinds of changes, is to create a new remote version for every clip to which you need to make an individual adjustment. Since each version is its own grade, and differently named versions don't link to one another, this is a simple solution.

To suspend linking by creating a new remote version:

1. Move the playhead to the clip you need to alter individually.
2. Do one of the following:
   - Choose Color > Grade Version > Add (Command-Y).
   - Right-click the thumbnail in the Timeline, and choose Remote Versions > Create New Version.
   - Using the DaVinci control panel, press ADD VERSION on the T-bar panel.
3. Grade the new version that's appeared.

While this method works well, keep in mind that multiple linked clips using the same version number will always be linked with one another. In other words, suppose Clip 1, Clip 3, and Clip 5 are linked using the default Version 1, which has a strong blue grade applied.
Three clips automatically linked, sharing a blue grade

Then, you set Clip 3 to use Version 2 with a different grade, tinted red. Clip 3 is now unlinked from Clips 1 and 5.

Setting the second of the three clips to use another version with a different remote grade sets it apart

However, switching Clip 5 to also use the red-tinted Version 2 means that Clip 3 and Clip 5 are now linked together, but Clip 1 is no longer linked.

Setting the third of these clips to share the same remote version as the second clip now links those two together, omitting the first clip

Every new remote version you create, and every change you make, becomes available to all other clips in all other timelines that comes from the same source Media Pool clip as the shot you’re working on. However, any clip can use any version, and which version is used by a linked clip is not rippled.

For example, Timeline 1 contains a clip named Max CU, which has three remote versions. Timeline 5 also contains Max CU, which is currently set to use Version 2. If you open Timeline 1 and add one more remote version to Max CU, that new version will also be available to Max CU in Timeline 5, but it will still be set to use Version 2.

Switching Clips Between Local and Remote Versions

You can also suspend remote version grade linking by switching individual clips to use local versions. This makes it easy to create a situation where some clips are linked, and other clips are not. Keep in mind that each clip has both local and remote versions, so you can switch from one to the other without losing anything.

To suspend linking by setting individual clips to use a local version:

– Right-click a clip thumbnail, choose the submenu of the corresponding remote version you want to copy, and choose Copy to Local. The remote version is copied to a local version, which now appears as the current version that’s used.

You can also set every clip in the entire timeline to use local versions. If you switch an entire timeline to local versions, then no clip in that timeline will be linked to any other unless you create a group.
(covered later in this chapter). This is the default state, but it’s useful even when you’ve switched to using remote versions when you want to grade one timeline differently from the others in a project, for example when doing a trim pass for another video or stereo 3D format, or when grading another cut, such as a trailer, that uses the same media but requires a different look.

To suspend linking by switching from remote versions to local versions:

- Right-click any clip thumbnail, and choose one of the following commands;
  
- **Use Local Grades**: Switches all clips to their local versions. If there are already local versions defined for each clip, those will appear. If there are no local versions yet defined, each clip will be ungraded.
  
- **Copy Remote Grades to Local**: Copies the currently assigned remote version of each clip to a local version.

Because Undo is used only for individual clip operations, the Use Local Grades and Copy Remote Grades To Local commands cannot be undone. However, switching a timeline from remote to local versions is not a one-way trip. You can select Use Remote Grades to switch every clip in a timeline back to the remote versions at any time.

To switch a timeline back to using remote versions:

- Right-click any clip thumbnail, and choose Use Remote Grades.

Furthermore, you can also copy the local grades you made to be remote grades, for instances where you started grading with local grades, and you want to switch to remote grading using your local grades as a starting point. Be aware that when you do this in a timeline with many clips that share the same source media, the grade of the very last shared clip in the Timeline will be the only remote grade that’s used for those auto-linked clips.

To copy each clip’s local grade to a remote grade for every clip in the current timeline:

- Right-click any clip thumbnail, and choose Copy Local Grades to Remote.
  
  If you’re switching back and forth between local and remote versions, keep the following rules in mind:
  
  - If you select Use Remote Grades, change your remote grades, and then Copy Remote Grades To Local on that timeline again, you’ll overwrite all of your previously graded local versions. This is a good workflow if you don’t like what you’ve done with your local versions, and you want to start over by recopying the remote versions.
  
  - If you select Use Remote Grades, change your remote grades, and then select Use Local Grades, you’ll return to your previously graded local versions, as they were before you selected Use Remote Grades. This is a good workflow if you just want to switch back to your remote versions in order to copy the remote versions of specific clips to local versions.

**Working with Versions**

Each clip can have as many local and remote versions as you like. There are commands for creating, renaming, and deleting the versions that are available to each clip when using the pointer, keyboard shortcuts, or the DaVinci control panel. When using the DaVinci control panel, the buttons affect whichever type of version (remote or local) is currently applied to the current clip.

Additionally, DaVinci Resolve 15 introduced the ability to batch create, rename, load, and delete versions for multiple clips that are selected at the same time.
To create a new local or remote version quickly for one or more selected clips, do one of the following:

– Choose Color > Grade Version > Add (Command-Y).
– Using the DaVinci control panel, press ADD VERSION on the T-bar panel.

A new version is created, identical to the type of version that was previously selected (remote or local), named “Version x” where x is the number of the versions that have been created. All keyframes and motion tracking are copied from the previously selected version to the new one.

To create a new version for one or more selected clips, with the option to set a name and whether to copy keyframes:

1. Right-click one of the selected clip thumbnails, and choose one of the following:
   – Local Versions > Create New Version
   – Remote Versions > Create New Version

2. Type a name for the version in the dialog that appears, and choose either “Copy all marks” or “Copy the first mark only,” depending on whether or not you want to copy all the keyframes into the new version.

   **NOTE:** Motion tracking will be copied regardless of whether “Copy all marks” is selected or not.

3. Optionally, you can choose one of the preset version names from the drop-down list. These names are defined in the Versions section of the General Options panel of the Project Settings.

4. Click OK.

To delete a specific version for one or more selected clips:

– Right-click one of the selected clip thumbnails, choose the submenu of the remote version you want to delete (it can’t be the currently selected version), and choose Delete.

To delete all versions for one or more selected clips:

– Right-click one of the selected clip thumbnails, and choose one of the following commands from the contextual menu corresponding to the scope of the versions you want to delete;
  – Local Versions > Delete All Versions
  – Remote Versions > Delete All Versions
  – Delete All Versions

All versions are deleted as specified, except for the currently selected version, which is now the only one remaining.

To load a particular remote or local version for one or more selected clips, do one of the following:

– Right-click one of the selected clip thumbnails, choose the submenu of the corresponding remote version you want to copy, and choose Load.

To rename the version of one or more selected clips:

1. Right-click one of the selected clip thumbnails, choose the submenu of the corresponding remote version you want to rename, and choose Rename.
In the Version Name dialog, type a name into the text field. Optionally, you can choose one of the preset version names from the drop-down list. These names are defined in the Versions section of the General Options panel of the Project Settings.

Selecting a Version name from the dropdown list, the names on the list come from assignments made using the Versions section of the General Options panel of the Project Settings.

Click OK.

That name now appears underneath the clip thumbnail in the Timeline.

If you’re going to use predefined names for versions, you need to define these in the Versions group of the General Options panel of the Project Settings. Ten drop-down menus let you choose from preset version names, or enter your own. These names will appear in the drop-down menu of the Version Name dialog.

The Importance of “Version 1”

There are specific operations in DaVinci Resolve where “Version 1,” otherwise known as “the default version,” is the only version that’s used, regardless of how many other versions are available, or which version was previously selected. The default version can be named anything you want, but whatever its name, the default version is the first version in the list, and it’s important. Here are some examples:

- Imported additional timelines that use the same clips: In this case, if you’re importing timelines and “Use local version for new clips in timeline” is disabled in the Color section of the General Options panel of the Project Settings, then only the default version of each clip is relinked.

- Whenever you switch a timeline between local and remote versions: In this case, every clip in the Timeline will be switched to the default version, regardless of what you had selected previously.
Consequently, if you plan to reconf orm your clips to a newer version of the edit that you’re importing, or pursue other workflows that are off the beaten path, it’s a good idea to make sure, no matter how many versions you end up creating, that the most important grade is always copied back to the default version.

**To copy any version quickly to the default version:**

1. Choose Color > Memories > Save Memory A (Option-1). You can use any memory you want, but Memory A is convenient for this example.
2. Choose Color > Grade Version > Default (Command-U).
3. Choose Color > Memories > Load Memory A (Command-1) to apply the saved memory to the default

**To copy any version quickly to the default version using the DaVinci control panel:**

1. Press CRNT and then press A (or any memory button you like). These controls are available on either the Transport or T-bar panel.
2. Press DEFAULT VERSION on the T-bar panel.
3. Press A (or whichever Memory button you used) to apply the saved memory.

**To jump immediately to the default version, do one of the following:**

– Choose Color > Grade Version > Default (Command-U).
– Press DEFAULT VERSION on the T-bar panel.

**Deleting Unused Versions**

In cases where you want to make absolutely sure there’s no alternative to the grade you want a clip to have, there’s an easy way to delete all versions except for the version that’s currently in use, thereby making it the default version.

**To eliminate either local or remote versions except for the current version:**

1. Choose the local or remote version you want a clip to use.
2. Right-click the thumbnail of the clip you want to eliminate extra versions from, and choose Delete Unused Versions from the contextual menu.

   If you selected a local version, all unused local versions will be deleted, but remote versions will be left alone. Similarly, if you selected a remote version, all unused remote versions will be deleted, but local versions will be left alone.

**To eliminate all other local and remote versions except for the current version:**

1. Choose the version you want a clip to use.
2. Right-click the thumbnail of the clip you want to eliminate extra versions from, and choose Delete All Versions from the contextual menu.

   Regardless of whether you selected a local or remote version, all other local and remote versions not in use will be deleted.

**Rendering Versions**

When the time comes to render your clips in the Deliver page, each clip’s currently selected version will be rendered. If you need to render a different version for a given clip, you can either make sure it’s selected in the Color Page timeline before you open the Deliver page, or use the Versions submenu in the Color mode of the Deliver page Thumbnail timeline. This contextual menu also provides access to the Stereo 3D commands, the Edit PAR (Pixel Aspect Ratio) command, and a command for updating the Render Window Timeline thumbnails to reflect any changes you’ve made in case they haven’t updated automatically.
Additionally, the Commercial Workflow output option, located in the Deliver page, provides a method of rendering multiple versions for each clip when outputting your project in Source Order (as individual media files). There are two additional options in the Version submenus of each clip in the Thumbnail timeline contextual menu that let you control which versions are rendered when you use Commercial Workflow.

- **Render Disabled**: Turning this option on excludes that version from being rendered when Commercial Workflow is enabled.
- **Enable Flat Pass**: Turning this option on forces the selected version to render with the grade turned off, essentially outputting the original media.

For more information on rendering versions using the Commercial Workflow option, see Chapter 186, “Rendering Media.”

### Copying Grades

There are various methods you can use to copy grades from one clip to another. Which is appropriate to your need depends on your style of working with DaVinci Resolve.

#### Protecting Adjustments with the Copy Grade Options

Before going into the myriad of ways that grades can be copied from one clip to another, you should know of a series of options, available from the contextual menu of the Gallery (right-click anywhere in the gray area of the Gallery), that let you carefully specify grading, sizing, and stereo data to be preserved when overwriting grades in clips you’re copying to. There are three options:

- **Copy Grade: Preserve number of nodes**: Lets you choose 0–10 nodes to be protected when applying a grade. When set to 1, the first node of the copied grade is ignored, but all other nodes are copied. When set to 5, the first five nodes of a copied grade are ignored, as long as there are at least five nodes in the grade of the clip you’re copying to. This option is useful for colorists who routinely use the first few nodes for shot matching and scene balancing, with additional nodes applying individual or stylistic adjustments.

- **Copy Grade: Preserve Camera Raw Settings**: When enabled, the camera raw Source settings of the current clip are preserved, letting you apply stylistic grades from unrelated clips without overwriting clip-specific source settings.

- **Copy Grade: Preserve Input Sizing**: When enabled, Input Sizing adjustments are not overwritten by those of the copied grade.

- **Copy Grade: Preserve Convergence**: When enabled, Convergence adjustments in the Stereo 3D palette are not overwritten by those of the copied grade.

- **Copy Grade: Preserve Floating Windows**: When enabled, Floating Windows adjustments in the Stereo 3D palette are not overwritten by those of the copied grade.

- **Copy Grade: Preserve Auto Align**: When enabled, Auto Alignment adjustments in the Stereo 3D palette are not overwritten by those of the copied grade.

- **Copy Grade: Preserve Dolby Vision™ Analysis Metadata**: When enabled, Dolby Vision Analysis Metadata is not overwritten by that of the copied grade. Only available if you’re set up to do Dolby Vision grading. For more information, see Chapter 8, “Data Levels, Color Management, and ACES.”

- **Copy Grade: Preserve Dolby Vision™ Trim Metadata**: When enabled, Dolby Vision Trim Metadata in the Dolby Vision palette is not overwritten by that of the copied grade. Only available if you’re set up to do Dolby Vision grading. For more information, see Chapter 8, “Data Levels, Color Management, and ACES.”
Copy and Paste From One Clip to Another

The simplest way to copy color adjustments from one clip and apply them to another clip is to use the same Edit > Copy and Paste commands shared with nearly every other application ever made. However, you can use this straightforward functionality in one of two ways, depending on the focus of the interface.

- If you click on the clip in the Thumbnail Timeline, you copy and paste the entire grade from one clip to another.
- If you click inside the Node Editor, you copy and paste only the selected node to another selected node.

You can override this focus-based selection, and make the default behavior to only copy between nodes rather than entire grades regardless of the interface focus. Do this by checking the “Always perform copy and paste on selected nodes” box in the Color section of the User panel in Preferences.

Methods of copying and pasting grades and node adjustments.

- To copy and paste an entire grade: Choose a clip with a grade you want to copy, and press Command-C. Then select the clip you want to copy the grade to in the Thumbnail Timeline, and choose Command-V to paste the entire grade.

- To copy and paste a single node: Choose a clip with a node you want to copy, and press Command-C. Then select the clip you want to copy the node to in the Thumbnail Timeline, and then click anywhere inside the Node Editor. Then choose Command-V to paste the node that was selected when you copied to the currently selected node in the node tree.

Copy and Paste Specific Parameters Using Paste Value

The Edit > Paste Value (Shift-Option-V) command lets you paste only the value of a specific parameter into the node of another clip.

To paste only a specific value:

1. Select a Corrector node with a parameter you want to copy, and press Command-C to copy it. You’re really copying the entire grade, but that’s okay.
2. Choose any other node in any grade, and open the palette that contains the parameter you want to paste into.
3. Double-click the number field of the specific parameter you want to paste the copied value into.
4. Choose Edit > Paste Value (Shift-Option-V) to paste that value.

**NOTE:** Paste Value only works for parameters within palettes; it does not work for OFX or Resolve FX in the Inspector.

Applying Saved Grades From the Gallery

Every time you save a still into the Gallery or a memory, it contains both the Clip grade, and the Timeline grade, if one is applied. Which grade is applied from a still using the Apply Grade or Append Node Graph commands depends on which mode the Node Editor is in. This is selectable from the drop-down menu in the upper right-hand corner of the Node Editor.
If you’re in Clip mode, you’ll only copy the saved clip grade. If you’re in Timeline mode, you’ll only copy the saved timeline grade.

**NOTE:** This mechanism also works for saving and applying grades for clips that are in Groups. The currently selected group grade in the Node Editor determines which grade is saved with a still, and the currently selected mode in the Node Editor determines where a saved grade will be applied.

**Preparing to Copy or Apply Grades**

For all other methods of copying or applying grades described in this chapter, there are some common methods of controlling how adjustments from the clip or still you’re copying from are applied to the clip you’re pasting or applying to.

**Choosing Which Aspect of a Grade to Apply with All/Color/Sizing**

When applying grades using any of the techniques described in this section, you can use the All/Color/Sizing setting that are available via the Mark > Keyframe Timeline Mode submenu, the drop-down menu that’s visible at the upper-right of the Keyframes Editor, or your DaVinci control panel. When copying a grade in conjunction with the settings in this menu, the following rules apply:

- **All:** When All is selected, both the grade and the sizing are copied.
- **Color:** Only the grade is copied, the target clip retains its original Input Sizing settings.
- **Sizing:** Only the Input Sizing is copied, the target clip retains its original grade.

**Choosing How to Copy Keyframes**

When copying or applying grades that have keyframes, you can choose how these keyframes are copied via a setting in the Gallery contextual menu by right-clicking anywhere in the gray background area of the Gallery, and choosing one of these options from the Apply Grades Using submenu. There are three options:

- **No Keyframes:** No keyframes are copied. The state of the grade at the frame used to save the still is what is applied to the target clip or clips.

- **Keyframes Aligning Source Timecode:** Keyframes are copied aligning the source timecode of the saved grade with the source timecode of the target clip. This is the ideal setting when you’re copying a grade back to the clip it came from originally, or to a duplicate of that clip elsewhere in the Timeline, and you want the keyframes to align with the same frames as before. If there is no source timecode overlap, keyframes will be pasted aligning with the start frame of the edit, the same as the third option (below).

- **Keyframes Aligning Start Frame:** Keyframes are copied aligning the start frame of the clip that still was saved from with the start frame of the target clip. This is the ideal setting when you’re copying a grade with keyframes from one clip to a completely different clip, with different timecode.

From that point on, keyframes, should they exist, will be copied or applied using the selected method whenever you copy a grade using any of the previously described methods.
Copying Grades Using the Pointer

An incredibly easy way of copying a grade from one clip to another, or from a still or memory in the Gallery to a clip, is by using the third button of your mouse, usually mapped as the “middle-click” of the mouse scroll wheel.

To copy a grade from a clip or still to one or more clips using the pointer:

1. Select the clip thumbnail you want to copy the grade to in the Timeline; a single selected clip appears highlighted orange. If you want to copy a grade to several clips, you can either Command-click multiple non-adjacent clips, or Shift-click a continuous range of clips; multiple selected clips appear highlighted red.

2. Middle-click the clip thumbnail, Gallery still, or memory you want to copy the grade from.

The grade of the clip you middle-clicked is copied to the previously selected clip or clips.

**TIP:** If you’re using a trackpad, third-party software may allow you to define a “three-finger-click” that works the same as mouse button 3. If you’re a pen and tablet or trackball user, you may be able to define a stylus or other button to perform the same button-3 action.

If you don’t have access to a middle-click on the pointing device you’re using, there’s another way of doing this using a contextual menu command.

To copy a grade from a clip or still to one or more clips using the Apply Grade command:

1. Select the clip thumbnail you want to copy the grade to in the Timeline; a single selected clip appears highlighted orange. If you want to copy a grade to several clips, you can either Command-click multiple non-adjacent clips, or Shift-click a continuous range of clips; multiple selected clips appear highlighted red.

2. Right-click the clip thumbnail, Gallery still, or memory you want to copy the grade from, and choose Apply Grade from the contextual menu.

The grade of the clip you middle-clicked is copied to the previously selected clip or clips.

Copy Forward Commands

Another simple way of copying grades is to use the equals (=) and minus (–) keys on the keyboard to copy grades forward from one or two clips behind the currently selected clip. This is a great way to copy grades in scenes with a shot-reverse-shot structure, where you’re cutting between two angles of coverage, each of which uses the same grade.

To copy grades forward:

- **To copy a grade from one clip back:** Choose Color > Apply Grade From One Clip Prior, or press Equals (=).
- **To copy a grade from two clips back:** Choose Color > Apply Grade From Two Clips Prior, or press Minus (–).

Copying Using Memories

Memories are virtually identical to stills, except that they’re labeled with a letter (A–Z) for easy access via keyboard shortcuts or DaVinci control panel buttons. A memory bank above the Gallery browser provides a visual reference of which saved grade is assigned to which letter. This makes it easy to keep track of multiple saved memories in instances where you’re copying them to several different clips throughout a scene or program.
For example, you might save a memory for each angle of coverage in a complicated scene, making it easy to copy grades forward. In another example, you might save a memory for the grade applied to each interview subject's headshot in a documentary, so you can copy that grade forward as you work through the documentary.

**To save the current clip's grade to a memory for future use, do one of the following:**
- Choose Color > Memories > Save Memory A–H (Option-1–8).

If you save a grade to a memory that already contains something, the previous memory is overwritten.

**To apply a memory to one or more clips in a timeline, do one of the following:**
1. Choose one or more clips in the Thumbnail timeline to copy to. This can be the current clip, or it can be a range of clips that you select by Command-Clicking or Shift-Clicking.
2. Do one of the following to copy a grade to the selected clips:
   - Right-click a memory and choose Apply Grade.
   - Choose Color > Memories > Load Memory A–H (Command-1–8).

**To clear a memory:**
- Right-click a memory, then choose Clear.

### Copying Using Preview Memory

You can also preview the effect of a memory or saved grade on the current clip, with the option to either keep it if it works, or go back to the previous grade if it doesn’t.

**To Preview Memory:**
1. Move the playhead to a clip for which you want to preview a memory.
2. Choose Color > Preview Memory (Option-Shift-P).
3. Do one of the following:
   - Right-click any saved still in the Gallery and choose Apply Grade.
   - Choose Memories > Load > Memory A–H (Command-1–8).

The selected grade or memory is now being previewed.

4. Now, do one of the following to either accept or reject the memory:
   - If you like the effect, then you can leave it be and move on to another clip.
   - If you don’t like the effect, then choosing Color > Preview Memory (Option-Shift-P) again reverts the clip to the original grade.

### Copying from Stills in the Gallery

As mentioned previously, each still you store in the Gallery contains the grading information as well as the image of the frame it was saved from. This saved grade can be applied to any clip in the Timeline.

**IMPORTANT**

Copied grades overwrite any previously existing grades on the clip or clips you copy to.
To apply a grade from a still to one or more selected clips in a timeline:

1. Choose one or more clips in the Thumbnail timeline to copy to. This can be the current clip, or it can be a range of clips that you select by Command-clicking or Shift-clicking.

2. Do one of the following to copy a grade to the selected clips:
   - Drag the still from the Gallery into the Viewer.
   - Right-click a still in the Gallery and choose Apply Grade.
   - Middle-click a still in the Gallery.
   - Double-click a still to wipe it in the Viewer against the current clip in the Timeline, then right-click the Viewer and choose one of the options from the Apply Grade submenu.

Append Node Graph

You can also append a saved grade to any clip in a timeline. This adds the entire node graph of the saved still to the end of the node tree of the current clip. In other words, the current clip’s grade isn’t overwritten, the applied grade is added to the end of it.

By planning ahead, you can save fragmentary grades that create specific effects or adjustments using only a few nodes. You can then use these fragmentary grades as a toolkit that you can add to other grades in order to mix and match different adjustments and effects.

For example, you could create a three-node glow effect, save it, and then apply that effect at the end of a completely different clip’s grade.

Appending grades places them after the original nodes

To append a saved grade or memory as individual nodes, do one of the following:
   - Drag a still or memory from the Gallery onto a connection line in the Node Editor; when the plus icon appears, drop it and its nodes will be appended within the node tree starting at that connection.
   - Right-click a still or memory in the Gallery, and choose Append Node Graph.
Ordinarily, when you append the node graph from a memory or still to another node graph, you end up adding a whole shedload of new nodes. This may be exactly what you need, but in situations where you want to keep things a bit tidier, you also have the option of appending node graphs as compound nodes.

**To append a saved grade or memory as a compound node:**
- Command-drag a still or memory from the Gallery onto a connection line in the Node Editor; when the plus icon appears, drop it and its nodes will be appended to the node tree as a single compound node.

**NOTE:** When you append the nodes from a gallery still to a grade, how keyframes are applied depends on the “Apply Grades Using” setting of the Gallery. For more information, see Chapter 138, “Using the Gallery.”

### Aligning Keyframes to a Specific Frame While Copying Grades

If you need to copy a grade with keyframes so that the start keyframe of the copied grade aligns with a specific frame of the Timeline, you can do so using the following procedure:

**To copy a grade and align its keyframes to a specific frame of the Timeline:**

1. Save a grade with keyframes as a Gallery still by right-clicking the Viewer and choosing Grab Still.
2. Choose the clip you want to copy the saved grade to in the Thumbnail timeline.
3. Double-click the Gallery still to wipe it against the current clip in the Viewer.
4. Move the playhead to the frame of this clip you want the first keyframe of the saved grade to be aligned with.
5. Right-click the Viewer and choose Apply Grade > Align Keyframes to Current Frame.

### Copying Individual Nodes and Settings

Copying grades from clip to clip copies everything except for keyframes and motion tracking. However, there is one way you can copy the motion tracking from one clip to another, and that’s by copying and pasting individual node settings. This can save time when you’re assembling complicated node trees by recycling specific nodes or node settings from previous grades.

### Copying and Pasting All Settings From One Node to Another

The simplest thing you can do is to copy all of a node’s settings, and paste them into another node. This makes it easy to duplicate things like windows, qualifier settings, keyframing, or motion tracking that you want to reuse in another node as the basis for another operation. This is also a quick way to manually ripple a change you make in a node to that same node in another clip’s grade.

**To copy a node’s settings from one clip to another, do one of the following:**

- Option-drag one node onto another. When you drop it, the settings of the node you dragged overwrite those of the node you dropped onto.
- Select a node with settings you want to copy and choose Edit > Copy (Command-C). Then, select a node you want to paste these settings to either in the current grade or in the grade of another clip, or create a new node, and choose Edit > Paste (Command-V) to paste the settings you copied. These pasted node settings overwrite any other settings that node previously used.
Paste Attributes on the Color Page

You can copy the settings of one node and paste a subset of those settings to another selected node by choosing Edit > Paste Attributes (Option-V). A Paste Attributes window appears that shows you which node you’re copying from, and which node you’re pasting to, and provides controls for choosing whether you want to paste keyframes and how to align them (Start Frames or Source Timecode), as well as a series of checkboxes for choosing which palettes, windows, and OFX/ResolveFX you want to apply. You can only paste all parameters from a specified palette; there’s no current provision for pasting specific parameters from within a given palette, with the exception of pasting specific windows and their accompanying trackers.

![The Paste Attributes window on the Color page](image)

Copying from the Node Graph of Other Clips or Gallery Stills

When constructing new grades, you may sometimes find it convenient to copy existing nodes or node settings from the grade of another clip or gallery still. This can be easily accomplished by exposing the node tree of any still that’s saved in the Gallery, or any clip in the Thumbnail timeline, and using the controls found in the floating node graph to copy individual nodes or node adjustments to the current clip’s grade shown in the Node Editor.

Copying Clip Settings Using Display Node Graph

In Clip mode, the floating Node Graph window has four sets of controls you can use to choose how to copy nodes and adjustments:

- **Clip Node Graph**: By default, the Clip node graph is displayed at the left. You can drag any node from the floating node graph to the current grade shown in the Node Editor, and drop it onto an existing node to overwrite that node’s settings or onto a connection line to insert it as a new node.

- **Timeline Node Graph**: (Only available if there is a Timeline grade) You can switch to the Timeline grade, if there is one, by either clicking the second button in the Node Graph title bar, or by choosing Timeline from the drop-down menu at the upper right-hand corner of the floating Node Graph window.
– **Apply Color/PTZR/Source/All buttons**: With the Clip panel selected, four buttons let you selectively copy the entire grade, the sizing, the source settings, or all settings at once to the current clip.

Dragging a node from another clip's node graph to the currently selected clip's grade in the Node Editor

**Copying Node Settings Using Display Node Graph**

In Node mode, the floating Node Graph window displays all of the available Color Attributes found within each node, instead of the Apply Color/PTZR/Source/All buttons:

– **Node Settings**: Use the checkboxes to choose which node adjustments get copied and which do not. After you've checked the settings you want to selectively copy, dragging a node from the floating node graph onto nodes in the Node Editor copies or appends the selected attributes into the target node, leaving all other attributes alone. For Windows and OpenFX, you have the option of also copying any motion tracking that’s available.

The Node panel open with the Color Corrector and Blur attributes selected for copying

**Ability to Open Compound Nodes in “Display Node Graph”**

When you right-click a Gallery still or a thumbnail and choose Display Node Graph for a grade that uses compound nodes, you can right-click any compound node and choose “Show compound node,” or Command-double-click a compound node to open it and see its individual nodes.
How to Copy Nodes Using Display Node Graph

The following procedures describe how to open the floating node graph in different situations.

To copy individual nodes or settings from any still in the Gallery:

1. Click the thumbnail in the Timeline of the clip you want to copy nodes to. Its node graph will appear in the Node Editor.

2. Right-click a still in the Gallery you want to copy nodes from, and choose Display Node Graph. A floating Node Graph window appears displaying that still’s node tree.

3. (Optional) While the Gallery Node Graph window is open, you can select any other still, and this window will update to show the currently selected still’s node graph, ready for you to copy from.

4. In the floating Node Graph window, choose Clip if you want to copy overall clip attributes, or choose Node to copy individual node attributes.

5. Do one of the following to copy nodes or settings to the Node Editor.
   - In Clip mode, drag any node from the floating node graph to the current grade shown in the Node Editor, and drop it onto an existing node to overwrite that node’s settings. If you open the Node panel and choose specific attributes, only those attributes will be copied to the node you drag onto.
   - In Clip mode, drag any node from the floating node graph to the current grade shown in the Node Editor, and drop it onto a connection line to insert it as a new node. If you open the Node panel and choose specific attributes, only those attributes will be copied to the new node that’s created.
   - In Clip mode, click Apply Color to copy the entire grade from the floating node graph to overwrite the current grade in the Node Editor.
   - In Clip mode, click Apply PTZR to copy the sizing from the floating node graph to overwrite that of the current clip.
   - In Clip mode, click Apply Source to copy the source settings from the floating node graph to overwrite those of the current clip.
   - In Clip mode, click Apply All to copy every setting from the floating node graph to the current clip.
In Node mode, select which attributes you want to copy, and then drag any node from the floating node graph to the current grade shown in the Node Editor, and drop it onto an existing node to overwrite the settings of that node that you selected.

In Node mode, select which attributes you want to copy, and then drag any node from the floating node graph to the current grade shown in the Node Editor, and drop it onto a connection line to insert it as a new node with only the settings that you selected.

While the floating Node Graph window is open, you can also select any clip in the Thumbnail timeline to change the grade that’s displayed in the Node Editor, ready for you to copy to.

Click Close when you’re finished.

To copy individual nodes or settings from any clip in the Timeline:

1. Click the thumbnail in the Timeline of the clip you want to copy nodes to. Its node graph will appear in the Node Editor.

2. Right-click the thumbnail of another clip you want to copy nodes from, and choose Display Node Graph.

NOTE: The Display Node Graph command only appears in the contextual menu of a clip in the Thumbnail timeline that is not currently selected.

(Optional) In the floating Node Graph window, choose Clip if you want to copy overall clip attributes, or choose Node to copy individual node attributes.

Do one of the following to copy nodes or settings to the Node Editor.

- In Clip mode, drag any node from the floating node graph to the current grade shown in the Node Editor, and drop it onto an existing node to overwrite that node’s settings. If you open the Node panel and choose specific attributes, only those attributes will be copied to the node you drag onto.

- In Clip mode, drag any node from the floating node graph to the current grade shown in the Node Editor, and drop it onto a connection line to insert it as a new node. If you open the Node panel and choose specific attributes, only those attributes will be copied to the new node that’s created.

- In Clip mode, click Apply Color to copy the entire grade from the floating node graph to overwrite the current grade in the Node Editor.

- In Clip mode, click Apply PTZR to copy the sizing from the floating node graph to overwrite that of the current clip.

- In Clip mode, click Apply Source to copy the source settings from the floating node graph to overwrite those of the current clip.

- In Clip mode, click Apply All to copy every setting from the floating node graph to the current clip.

- In Node mode, select which attributes you want to copy, and then drag any node from the floating node graph to the current grade shown in the Node Editor, and drop it onto an existing node to overwrite the settings of that node that you selected.

- In Node mode, select which attributes you want to copy, and then drag any node from the floating node graph to the current grade shown in the Node Editor, and drop it onto a connection line to insert it as a new node with only the settings that you selected.
While the floating Node Graph window is open, you can also select any clip in the Thumbnail timeline to change the grade that's displayed in the Node Editor, ready for you to copy to.

Click Close when you're finished.

Rippling Adjustments Among Multiple Clips

If you’ve graded a sequence of clips and find yourself needing to make a quick change to several clips all at once, you can use the Color > Ripple Node Changes to Selected Clips/Current Group commands to quickly copy changes made to one clip to several others. However, these commands require that you follow certain rules in order to get the results you want.

Node rippling uses the number of each node to determine what changes should ripple to which nodes. In other words, changes made to Node 3 will ripple to Node 3 of every other selected clip, or to Node 3 of every other clip in the current group (depending on which command you use).

Rippling changes from one clip to several others requires that all clips share the same number of nodes, at least for the nodes you’re rippling. If you try to ripple a change to one or more clips that don’t have a node with the same number as the one you’re rippling, then no change will be rippled to those clips.

To ripple a change in one node to several selected clips:

1. Select the clip you want to use to make the change so that it’s the current clip, outlined in orange.
2. Now, Command-click or Shift-click to select the range of clips you want to ripple your change to, so that they’re all selected red.

You don’t have to select the clips you’re going to ripple your change to prior to making the change, but it may be easier to keep track of what you’re doing if you set everything up in advance. The clip you’re changing should be outlined in orange, and the clips you’re rippling the change to should be highlighted in red.

3. Select a node to modify. Ideally, every selected clip should have a node sharing the same number as the one you’re modifying. If some clips don’t, then those clips won’t inherit the change you’re going to be rippling.
4. Make whatever changes you need to, adjusting any of the palette controls in the Color page you need to, except for Camera Raw, Sizing, and Data Burn, which aren’t node-specific.
5. When you’re happy with the change you’ve made, choose Color > Ripple Node Changes to Selected Clips.

The change you’ve made should ripple to every other selected clip with a node of the same number, and in a few moments the thumbnails of those clips should update to show the change.

If you’ve created a group, it’s even easier to ripple node adjustments to the other clips in the group.
To ripple a change in one node to the current group:

1. Select the clip you want to use to make the change so that it’s the current clip, outlined in orange. It must be part of a group for this to work.

2. Select a node to modify. Ideally, every selected clip should have a node sharing the same number as the one you’re modifying. If some clips don’t, then those clips won’t inherit the change you’re going to be rippling.

3. Make whatever changes you need to, adjusting any of the palette controls in the Color page you need to, except for Camera Raw, Sizing, and Data Burn, which aren’t node-specific.

4. When you’re happy with the change you’ve made, choose Color > Ripple Node Changes to Current Group.

   The change you’ve made should ripple to every other clip in the current group that has a node of the same number, and in a few moments the thumbnails of those clips should update to show the change.

Appending a Node to Multiple Clips

If you’ve made an adjustment to a node in one clip that you’d like to apply to several other clips, you can quickly do that using the Color > Append Node to Selected Clips command. You can do this as a prelude to using one of the Ripple Node Change commands, as it’s a quick way to make sure several previously ungraded clips have the same nodes, but you can also do this as a quick way to apply the same node change to several clips, regardless of whether they have matching node trees.

To append a node to other selected clips:

1. Select the clip you want to use to make the change so that it’s the current clip, outlined in orange.

2. Select the node you want to append to other clips.

3. Now, Command-click or Shift-click to select the range of clips you want to ripple your change to, so that they’re all selected red.

   The clip you’re copying from should be outlined in orange, and the clips you’re rippling the change to should be highlighted in red.

4. Choose Color > Append Node to Selected Clips.

   The selected node should be appended to the end of the node tree of each selected clip, and in a few moments the thumbnails of those clips should update to show the change.

Using Shared Nodes

Shared nodes are meant to be a way to extend the benefits of automatically rippled changes among different clips to colorists that prefer a flatter node structure than Group Grading allows. By turning individual Corrector nodes into Shared nodes, and copying these to multiple clips, you enable linked adjustments right from within the clip grade. This means that the clip grade can freely mix both clip-specific nodes and Shared nodes, all within the same node tree. This makes Shared nodes fast to use as there’s no need to create groups or switch to a group node tree (covered in the next section) to reap the benefits of linked adjustments among multiple clips.
What Are Shared Nodes Good For?

Shared nodes are similar to group grades, except that they don’t require grouping and can be added to any normal grade. Changes made to a Shared node are automatically rippled to all other instances of that node in the grades of other clips. Furthermore, you can add as many Shared nodes to a grade as you like, and you can arrange them in any order to control the order of the operations they apply. And, of course, you can intersperse them with ordinary Corrector nodes.

Shared nodes are extremely flexible. For example, you can use Shared nodes to:

– Add a Color Space Transform Resolve FX or a LUT to the beginning of every clip from a particular source
– Add a base correction to every talking head shot of a particular interviewee
– Add a shot matching adjustment to each clip from a particular angle of coverage within a scene
– Add a stylistic adjustment to every clip in a specific scene
– Make your base adjustments when grading with remote versions, so those adjustments remain linked when you copy your remote versions to local versions for fine tuning

In fact, you can mix and match Shared nodes among differently overlapping sets of clips to accomplish any or all of the above at once. For example, you can add one Shared node to make an adjustment to every clip from a particular camera, add a second Shared node to each of those clips that are in a particular scene, and then add a third Shared node to whichever of those clips happen to be a closeup of the lead actress, before adding one or two regular Corrector nodes that aren’t shared to make clip-specific tweaks.

IMPORTANT

At the time of this writing, there is a limitation when using Shared nodes. Grades using shared nodes cannot be used in collaborative workflows. It is hoped that this limitation is temporary.

Creating Shared Nodes

Creating a Shared node is easy, assuming you’ve created a node that has an adjustment you’d like to share among multiple clips.

To create a Shared node:

– Right-click any Corrector node and choose Save as Shared node.

Locking Shared Nodes

Once you turn a node into a Shared node, that node is automatically locked, preventing you from accidentally making adjustments to it that would affect all other grades using that same Shared node.

To toggle the locked status of a Shared node, do one of the following:

– Right-click any Shared node and choose Lock Node from the contextual menu.
– Open the Keyframe Editor, and click the Lock icon in the track header of that node’s keyframe track.
Copying Shared Nodes

Because Shared nodes are essentially Corrector nodes within clip grades, they’re easy to work with. Once you’ve created one or more Shared nodes, there are a variety of ways you can copy them to the grades of other clips in your program to take advantage of the linked adjustments they let you make.

Ways of copying Shared nodes among multiple clips:

- **Add a Shared node to another clip’s grade using the Node Editor contextual menu:** Once you save a node as a Shared node, it becomes available from the bottom of the Add Node submenu of the Node Editor contextual menu, making it easy to add any Shared node to any clip. If you customize the label of the Shared node, that custom label appears in the contextual menu, making it easier to find what you’re looking for.

- **Add Shared nodes to a basic grade you’ll be copying to other clips:** If you create one or more Shared nodes when you initially build a grade, copying that grade to other clips naturally copies the Shared nodes as well.

- **Save a Shared node as a Gallery still and apply it to other clips:** If you save a grade with a Shared node in it to the Gallery, then every time you copy that Gallery still to another clip, you copy its Shared node.

- **Create a Shared node and append it to a selection of additional clips:** If you’ve already graded several clips in a scene, you can add a Shared node to the end of one of the clips grades and make sure it’s selected, then select all of the other clips in the scene and choose Append Node to Selected Clips.

- **Use Shared nodes to preserve linked adjustments when copying remote grades to local grades:** If you use Shared nodes to make your base adjustments when you grade using Remote Versions to automatically copy those grades to other clips that come from the same source media, those adjustments will remain linked when you copy your remote versions to local versions for fine tuning.

You can also choose options in the Gallery that dictate what happens when you copy a grade that has shared nodes within it.

Converting Shared Nodes Back to Corrector Nodes

Sometimes you need to stop a node from being shared. For example, if you want to copy a grade from another scene to use as the starting point for a new grade, chances are you don’t want any shared nodes to continue being shared as you customize that grade for the new scene. In this instance, you can convert the Shared node back to a regular Corrector node, make any adjustments you need to customize it for the new scene, and then turn that node into a brand new Shared node that’s specific to the new scene.

To convert a Shared node back to a Corrector node:

- Right-click any Shared node, and choose Convert to Corrector from the contextual menu.

Deleting Shared Nodes

If you’ve created a Shared node that’s being used in multiple clips, and you decide you want to eliminate the linked relationship among these nodes so they all work independently, you can “delete” a specific Shared node. This leaves the now unlinked nodes intact within each node tree in which they appear, but clears their effect. Additionally, that Shared node is removed from the Add Node submenu.

To Delete a Shared node:

- Right-click any Shared node, and choose a node to delete from the Delete Shared Node submenu.
Using Adjustment Clips

You can also apply a single grade to multiple clips in the Timeline using Adjustment clips that have been superimposed over numerous other clips in the Timeline. They can be used to apply a single grade to all clips in a scene, or to add further color adjustments or trims to a section of clips via a second grade that’s applied on top of the individual clip grades that are already applied.

Adjustment clips are a great way to add adjustments to multiple clips that you may be making frequent changes to. If you make changes to a grade in an Adjustment clip, that change is automatically applied to all clips underneath it in the Timeline. Additionally, grades applied via adjustment layers can be turned off by disabling the adjustment layers, either one at a time, or by disabling an entire track with adjustment layers in it.

Adjustment clips can be edited into the Timeline on the Edit page, and are available from the Effects bin of the toolbox in the Effects Library. When an Adjustment clip is superimposed above one or more clips in the Timeline, all effects that are applied to the Adjustment clip are also applied to all clips underneath it.

Adjustment clips can be used to apply the following types of effects:

- ResolveFX and OpenFX plug-ins
- Inspector parameters, including Composite, Transform, Cropping, and Dynamic Zoom
- Fusion page effects
- Color page grading and sizing

Effects clips are a fast and easily revised way to apply one or more grades and effects to a range of clips.
TIP: Multiple adjustment layers can be grouped together so that you can apply Group and Clip grades to adjustment layers, linking multiple adjustment layers together in situations where you want to apply the exact same trim or stylistic adjustment to multiple scenes in non-contiguous areas of the Timeline.

Using Groups

Grouping is one of DaVinci Resolve’s most powerful features for organizing grades amongst multiple clips. Groups are manually created collections of clips with automatic linking relationships that make it easy for you to control the rippling of grades among sets of clips that you define. When clips have been grouped together, selecting one member of the group reveals a group “linked” badge at the top-right of each clip’s thumbnail belonging to the group.

You can create as many groups within a single project as you need. You can add or remove shots from the current group, and the current group is defined by the last shot you’ve selected (if it belongs to a group, that’s the new current group).

As introduced in DaVinci Resolve 11, the grading of grouped clips is easier than it has ever been. Once grouped, you can choose from one of four Node Editor modes to grade the current clip. Which mode you choose determines whether that grade will automatically ripple to every other member of that group, or whether the grade will only affect that one clip. In this way, you can combine multiple node trees, some which will ripple, and one which won’t, to create the final look of each clip in that group.

For example, you might group together every clip from the same angle of coverage in a scene. You might also group together every clip from a particular section of B-roll that will be graded with the same treatment. This way, whenever you make a change or otherwise update one member of the group using one of the rippled Node Editor modes, every clip in the group will be changed together.

This section discusses how to create and manage groups, how best to use them, and what issues you need to be aware of to use groups to best advantage.

Creating and Managing Groups

The following procedures describe how to create, load, modify, and delete groups.

To create a new group:

1. Select one or more clip thumbnails in the Timeline. You can select a contiguous range of clips by clicking one and then Shift-clicking another, or you can make a noncontiguous selection by Command-clicking individual clip thumbnails anywhere in the Timeline.

2. Right-click one of the selected clip thumbnails, and choose Add Into New Group.

3. Type a name into the field of the Group Name dialog, and click OK.

The new group is created, and the clips you had selected now appear with the “linked” group badge above the thumbnails.
To load a different group, do one of the following:

– Move the playhead to another clip that’s a member of that group.
– Right-click any clip belonging to any group, and choose Group > “Name of group” > Load.

The selected group now becomes the current group. Using the Add Into Current Group command will add a clip to the newly loaded group.

To add one or more clips to an existing group:

1 Load the group you want to add clips to.
2 Select one or more clip thumbnails in the Timeline. You can select a contiguous range of clips by clicking one and then Shift-clicking another, or you can make a noncontiguous selection by Command-clicking individual clip thumbnails anywhere in the Timeline.
3 Right-click one of the selected clip thumbnails, and choose Group > “Name of group” > Assign to Group.

The selected clips now appear with the “linked” group badge above the thumbnails.

To remove one or more clips from an existing group:

1 Select one or more clip thumbnails in the Timeline that you want to remove from a group. You can select a contiguous range of clips by clicking one and then Shift-clicking another, or you can make a discontiguous selection by Command-clicking individual clip thumbnails anywhere in the Timeline.
2 Right-click one of the selected clip thumbnails, and choose Remove From Group.

To rename a group:

1 Right-click any clip belonging to any group, and choose Group > “Name of group” > Rename.
2 Type a new name into the field of the Group Name dialog, and click OK.

The group is renamed. The new name appears as a new submenu of the Timeline contextual menu.

To delete a group:

– Right-click a clip belonging the group you want to delete, and choose Group > “Name of group” > Delete.
– This clears the group, while preserving the last applied grade within each clip.

Using Group Modes to Control Which Grades Ripple and Which Don’t

When you create a group and then select any clip that is a member of that group, additional Node Editor modes become available that let you apply multiple levels of grades to the clips in that group.
For clips that aren’t grouped, two dots at the top of the Node Editor let you switch between Clip and Timeline modes via a single click. If you’re working on a clip that’s part of a group, four dots will be displayed to allow fast access to the Pre-Clip and Post-Clip Group modes as well.

Four dots at the top of the Node Editor let you choose which mode you’re working on

Node trees you create using the Group Pre-Clip and Group Post-Clip modes automatically ripple changes to every member of a group. Node trees created with the Clip mode are specific to each clip. Node trees created with the Timeline grade affect the entire Timeline, all at once. Combining node trees made using these different modes makes it easy combine clip-specific changes with group-wide changes that make grading faster.

– **Group Pre-Clip:** Node trees assembled in this mode affect every clip in the group simultaneously. Pre-Clip adjustments are useful for creating an overall grade that you want to use as a starting point for the scene, such as when you need to normalize a group of log-encoded clips in a specific way, or when you want to create a base grade that generally improves every clip in a scene.

– **Clip:** The Clip grade corresponds to the local or remote version associated with that clip. Node trees assembled in the Clip mode only affect the specific clip that’s selected. All Local and Remote versions you create are in Clip mode. Clip adjustments are useful for matching clips to one another in a scene, doing clip-specific secondary adjustments, or making any other sort of adjustment that you only want applied to the current clip, rather than to the group as a whole. Clip adjustments are applied after Pre-Clip adjustments.

– **Group Post-Clip:** Node trees assembled in this mode also affect every clip in the group simultaneously, but these adjustments are applied after the Clip adjustments. Post-Clip adjustments can be useful for applying a creative look to an overall scene, so that later revisions to a scene’s look can be accomplished with a single set of adjustments that automatically affect the entire group.

– **Timeline:** Node trees assembled in this mode affect every single clip in the entire Timeline. Timeline adjustments are useful when you have a single change that you want to apply to every single clip at once.

The image processing of each Node Editor mode is sequential, making it easy to keep track of the order of operations affecting a particular clip.

**An Example of Grading a Group of Clips**

This section shows an example of how you might approach grading a group of clips using the different Node Editor modes that are available. Keep in mind that this is only one of many possible approaches you could take to the use of groups, and was chosen because it exercises everything you can do to a single grade.

To get started, select a series of clips that you want to group, and right-click one of them and choose Create New Group to group them together, entering a name and clicking OK when prompted. One convenient advantage of simply creating groups from a selection is that you’re not limited to selecting a continuous range of clips in the Timeline. Another advantage is that you can use the View > Timeline Thumbnail Mode > Source (C-mode) command, or Timeline filtering, to isolate the range of clips you want to use for creating a group.
There are different ways you might choose to group clips together:

– All clips within a particular scene
– All clips recorded from a specific camera
– All headshots of a particular person
– All clips from a particular angle of coverage
– All exteriors of a particular location

The list could go on and on, but you get the idea. You can group any selection of clips together that have reason to share a common grade. In this example, a series of shots from an exterior scene are selected and made into a group.

Once you’ve created a group, choose Group Pre-Clip from the Node Editor mode drop-down. This is the first grade that’s applied, as the underlying grade that affects the entire group. Using this node tree, adding a LUT to normalize the clips, a Color Wheel adjustment, and some Curve adjustments to tune the color provide a primary grade that now affects every single clip in the group.

With this accomplished, you can see there’s some variation among the clips in the scene that needs to be corrected in order for every clip to match. Choose Clip from the Node Editor mode drop-down. Grades that you make in Clip mode only affect the clip to which they’re applied, so now you can work clip by clip using the Image Wipe and Split-Screen controls to compare clips and make whatever adjustments are necessary to make each one match the main look for the scene.
Scene balancing adjustments made using the Clip mode

Once all the clips are balanced with one another, you can choose Post-Clip Group from the Node Editor mode drop-down. This lets you add one more grade on top of the Pre-Clip and Clip grades that you’ve already applied, that you can use for any number of things. In this example, a single stylistic adjustment is applied that now affects all of the clips at once. If a client wants to see something different, you can easily make the necessary changes to one clip, and all other clips in that group will immediately be altered as well.

A stylistic adjustment applied to the Group Post-Clip mode

At this point, the scene is graded via a well organized set of corrections. If the client later wants a change affecting the underlying primary grade that everything is built on, you can adjust the Pre-Clip grade. If you spot an inconsistency with your shot matching at any point, you can make a fast tweak to the relevant Clip grade. And if the client wants a stylistic change, you can make any necessary adjustments to the Post-Clip grade to change the overall look of the whole scene. In each case, groups give you total control over which adjustments will ripple across the whole group, and which adjustments will be clip-specific.

Using Undo in Groups
Each Node Editor mode has a separate undo stack, meaning that separate multiple-level undo is saved for Group Pre-Clip, Clip, and Group Post-Clip.

Saving Stills and Grades in Groups
When you save a still for a clip that’s part of a group, the result is that the still reflects the look of the combined Pre-Clip, Clip, and Post-Clip node trees, but the grade that’s saved within depends on the Node Editor mode you had selected when saving the still. For example, if the Node Editor is set to Group Pre-Clip, then you’ll only save the Pre-Clip grade; the Clip, Group Post-Clip, and Track grades will be ignored. Copying a saved grade to a clip in a group results in that grade being copied to the node tree of whichever Node Editor mode is currently open.
Collapse Group Grades

If you want to take a clip out of a group, but you want its grade to continue incorporating all adjustments made in the Pre-Group and Post-Group Node Editor modes, you can use the Collapse Group Grades command to copy all nodes in the Pre-Group and Post-Group grades to the Clip grade. When you do this, Pre-Group nodes are added before any pre-existing nodes in the Clip grade, and all Post-Group nodes are added after, in order to maintain the correct order of operations.

To flatten all group grades into a single Clip mode node tree:

- Right-click a clip’s thumbnail in the Thumbnail timeline, and choose Collapse Group Grades from the contextual menu.

Using Collapse Group Grades on a clip always removes that clip from whatever group it was previously a member of. This can also be an easy way of creating a single flat node tree in preparation for saving a grade to the Gallery for applying to other clips that aren’t themselves in groups.

Groups and Versions

Local or Remote versions you create relate only to the Clip grade. Group Pre-Clip and Group Post-Clip grades cannot be versioned.
Exporting Grades and LUTs

If you find it necessary to exchange grades with other workstations, there are two ways you can do so directly: by exporting grades, or LUTs. This section discusses the export of Grades; for more information about exporting LUTs, see Chapter 147, "Using LUTs."

To export a grade:
1. Save the grade you want to export as a still in the Gallery.
2. Right-click the saved still in the Gallery, and choose Export.
3. Select the image format you want to save the still as. Choices include: DPX, Cineon, TIFF, JPEG, PNG, PPM, BMP, and XPM.
4. Choose a location for the resulting still image and saved grade files, type a name into the Save As field, and click Save.

Two files are saved. The image file contains the still image of the frame that was stored. A DRX (DaVinci Resolve eXchange) file contains all the grading information.

To Import a grade:
1. Right-click anywhere in the gray area of the Gallery, and choose Import.
2. Click the Options button to select the specific file type you want to import, or select "All Files" for multiple formats.
3. Choose the image file that was exported from your DaVinci Resolve workstation, or someone else’s. The accompanying DRX file must be in the same location. If you lose the original image file, you can still import the DRX file by itself. It will preserve the node structure of the still, but you will not be able to wipe against it.

The still you imported appears in the Gallery, containing the grading information you wanted to import.
Chapter 140

Node Editing Basics

This chapter covers the basics of using the Node Editor in DaVinci Resolve to manage all of the adjustments you decide to apply to a clip, as well as the fundamental procedures for editing and organizing nodes within a tree that are the basis for creating more sophisticated effects.

Contents

Node Editor Basics 2792
Thumbnail-Optional Nodes 2792
The Node Editor Interface 2793
The Components of a Node Tree 2794
Node Badges and Labels 2796
Selecting Nodes 2796
Disabling Nodes 2797
Turning Grades and/or Fusion Effects Off 2798
Resetting Nodes 2799
Previewing and Restoring Node Trees 2799
Caching Specific Nodes to Improve Performance 2800
Editing Node Trees 2800
Adding Nodes 2800
Adding Nodes with Windows Turned On 2801
Deleting Nodes 2801
Connecting and Disconnecting Nodes 2801
Extracting a Node 2802
Inserting a Node 2802
Rearranging Node Order 2802
Copying and Pasting All Settings From One Node to Another 2803
Keeping Node Trees Organized 2803
Node Editor Basics

By default, every clip has one node in the Node Editor that contains the first corrections you make. However, you also have the option of creating multiple nodes, where each node contains one or more corrections that affect the image.

The specific arrangement of nodes you create lets you exert precise control over the order of operations performed by your grade, which provides many advantages. This section covers different ways of creating, editing, and arranging node trees to harness the full power of DaVinci Resolve.

Thumbnail-Optional Nodes

The Node Editor option menu provides a Show Thumbnails option that lets you disable or enable the thumbnails attached to each Corrector node.
Disabling thumbnails in the Node Editor option menu makes nodes shorter.

How Many Nodes Do I Need to Use?

In this chapter and the ones that follow, you'll learn many different techniques for combining adjustments and nodes in different ways to achieve highly specific effects. Consequently, new DaVinci Resolve users often wonder, how far do I go? There is no right answer, but suffice it to say that some of the world’s leading colorists achieve stunning results in as few as three or four nodes, while others routinely build carefully organized hierarchies of ten to twenty nodes, or more. The number of nodes you use is often dependent on the quality of media you’ve been given to work with, as well-lit footage usually requires less work than material shot run-and-gun with available light, that typically needs many more adjustments to achieve an acceptable result. Furthermore, the number of nodes you may use can also depend on what kind of program you’re working on, with commercial spots affording the colorist enough time in the schedule to build truly massive grades that adjust every little detail, and narrative features and television shows requiring you to work faster and do more within fewer adjustments in order to stay on track. The real answer? Each grade requires as many nodes as are necessary. No more, no less.

The Node Editor Interface

As you work within the Node Editor, you may find the need to zoom into or out of it to get a better look at the node tree, and to pan around the working area to deal with large collections of nodes.

To expand the size of the Node Editor’s working area:

- Drag the border between the Node Editor and the Viewer to the left or right to make it wider or narrower.
- Right-click anywhere within the Node Editor (except on a node) and choose Toggle Display Mode, which hides the Viewer and moves the Node Editor to the right of the Gallery, enlarging it considerably. Right-click and choose Toggle Display Node again to return to the default layout.

To arrange the node tree to fit your current working area:

- Right-click anywhere in the Node Editor (except on a node) and choose Cleanup Node Graph from the contextual menu. This will rearrange your node tree to fit in whatever size working area you have at the time.
To zoom and pan within the Node Editor, do one of the following:

- Use the Node Editor’s zoom slider to shrink or enlarge the nodes in the Node Editor.
- Click the Pan tool (the hand icon) at the upper left-hand corner of the Node Editor, and drag anywhere within the gray area of the Node Editor to pan around.
- Press the H key to toggle between selection and pan modes in the Node Editor.
- Middle-click and drag anywhere within the Node Editor to pan around.
- Right-click and choose Zoom In or Zoom Out.
- Right-click and choose Zoom to Window to fit the node tree to the current size of the node graph.
- Right-click and choose Original Size to return the node graph to the default size.

The Components of a Node Tree

Ambitious grades may require trees of multiple nodes to create the necessary effect. This section covers the mechanics of putting nodes together into the structures that are described in more detail later in this chapter.

Every node you add is a “Corrector” node, which is capable of either primary or secondary correction, depending on whether or not you enable the Qualifier/Window/Matte controls. Even “Serial” and “Parallel” nodes are simply Corrector nodes that are added in series or in parallel to the previous node in the node tree; the names are a consequence of how they’re added.

Each Corrector node has two inputs and two outputs, which lets you separately manage the RGB image-processing channel, and the Key channel that defines areas of isolation for image processing operations, or transparency for compositing. RGB connections are light green, located at the top left and right of each node. Key connections are blue, located at the bottom left and right of each node. Inputs into the node are triangles, and outputs are squares. These inputs and outputs let you control the flow of image and isolation channels coming into and going out of each node in the tree.

Nodes are attached to one another via “connections,” seen as lines that connect one node to another. Image data flows from left to right, starting with the Source input all the way at the left of the Node Editor, through each node in the tree, and ending at the Node Tree output at the right of the Node Editor.
Here’s an explanation of the different components of a basic node tree where all nodes are connected in serial, one after the other, and how they work together:

- **Source Input:** The green source node to the far left is the clip’s image data as processed by the Sizing and Source decode settings, ungraded. The Source input feeds RGB data to the grade, and is connected to the RGB input of the first node in your tree. If necessary, you can connect the Source input to more than one Corrector node, creating multiple simultaneous streams of image processing emerging from the original source state of the image that you can eventually recombine in different ways using the Parallel or Layer Mixer nodes.

- **Nodes:** Each node in the node graph represents a collection of image processing operations that can be enabled or disabled separately from any other node in the graph. By separating operations into multiple nodes, you're able to precisely control the order of all image processing operations in DaVinci Resolve to create many different corrections and effects. The green RGB inputs and outputs are used to connect these nodes together. Each node’s thumbnail image shows how the clip looks at that particular stage of the grade, giving you a visual indication of what each node is doing, and small badges below each node show you which specific operations are being applied by that node.

- **RGB Inputs and Outputs:** The green inputs and outputs at the upper right and left of each node are used to connect the RGB image that’s output from one node to the RGB input of the next node. For a Corrector node to have an effect, you must connect both its RGB input and its RGB output to neighboring nodes in the tree. Furthermore, every single node in the Node Editor must be connected for a grade to be enabled; having any disconnected node in the node tree disables that grade until it’s fully connected.

- **Key Inputs and Outputs:** The blue inputs and outputs at the bottom right and left of each node are used to route the key channel generated by a node’s Qualifier or Window controls, or imported via a Matte clip that you previously associated with a clip in the Media page. When you connect the key output of one node to the key input of another, you basically copy the first node’s key to the second node. You can also combine the key outputs of multiple nodes in various ways using the Key Mixer node.

- **Node Tree Output:** The RGB output of the last node in a tree must be connected to the green Node Tree output node, which “completes the circuit” of image processing, and passes that correction on to the next stage in the DaVinci Resolve image processing pipeline. If the output is not connected, the node tree is disabled and has no effect on the clip. You can only connect one RGB output at a time to the Node Tree output.

- **Second Source Input (for RED HDRx):** You can access the alternate highlight exposure of RED HDRx media by exposing this optional second Source input. For more information, see “Multichannel RED HDRx Support” in Chapter 144, “Channel Splitting and Image Compositing.”

- **Second Source Input (from Fusion page):** You can also create additional sources to route in masks or mattes created in the Fusion page for use as keys in the Color page.

- **Alpha Output:** It's possible to create regions of transparency for compositing directly in DaVinci Resolve by connecting a key output to an optional Alpha output. For more information, see Chapter 143, “Combining Keys and Using Mattes.”
Node Badges and Labels

Nodes appear with various labels and badges to help you identify what each node is contributing to the overall grade. How long a label and how many badges appear depends on the size of each node, as set by the Node Editor’s Zoom slider.

Nodes showing the kinds of labeling and badges that are available for identifying what operations each node is performing

- **Node number**: Nodes are numbered in the order in which they appear in the node graph, making it possible for you to select specific nodes by number via the DaVinci control panel.

- **Adjustment badges**: As you apply various operations within a node, small badges appear underneath the thumbnail that indicate which palettes have been used to adjust that node. How many badges are visible depends on how far in or out you’re zoomed into the Node Editor, and whether or not there are Color Space or HDR labels already taking some of this room. At larger node sizes, more badges can appear within the width of the node. Each palette in the Color page has a unique badge. If you apply more operations than a node has area to display, a single “downward arrow” badge appears.

- **Animation badge**: Nodes with animated parameters display a keyframe badge.

Labeling Nodes

Nodes can be labeled to identify a particular node’s function in your grade. This can make it easier to revise a grade months later. Node labels are also saved when you save a still, so labels can also make it easier to decipher a saved grade down the road. At each node’s default size in the Node Editor, nodes can appear with up to 12 characters of text, although larger nodes can accommodate more text.

**To label a node:**

1. Right-click a node and choose Change Label.
2. Type the label text you want and press Return.
   
   The label you entered appears above the node in the Node Editor.

**To edit a node’s label:**

- Once a node has a label, you can change the label at any time by double-clicking it.

Selecting Nodes

The node that’s currently selected in the Node Editor is highlighted in orange, and is referred to as the current node. When you adjust any of the parameters or settings in the Color page, you’re adjusting parameters within the current node. You can only select one node at a time.

**To select a node, making it the current node, do one of the following:**

- Click any node in the node graph.
- Choose Color > Nodes > Previous Node (Option-Shift-Semicolon) or Color > Nodes > Next Node (Option-Shift-Apostrophe). When you do this, the last node loops around to the first one, and vice versa.
The selected node appears highlighted in orange. You also have the ability to select multiple nodes, in preparation for doing things like moving them or creating compound nodes (covered later in this chapter).

**To select multiple nodes:**

- Command-click each of the nodes you want to simultaneously select.
- With the Node Editor Selection tool chosen (at the upper left-hand corner of the Node Editor) simply drag to select multiple nodes using a bounding box.

When you select multiple nodes, each one appears highlighted in white, with the exception of the current node, which remains orange.

When you select another clip in the Timeline, the default behavior is that the last node that was selected when you worked on that clip is the one that’s selected when you move to that clip again. However, a setting in the option menu of the Node Editor and the Color panel of the User Preferences, called “Switching clips,” lets you change this behavior. For more information on this option, see Chapter 4, “System and User Preferences.”

### Disabling Nodes

In the process of creating a node tree, it’s often useful to turn one or more selected nodes off to disable their effect on your grade. It’s also useful to turn the entire node tree off and on in order to see “before and after” views of the current clip. Disabled nodes are not processed during rendering, and they remain disabled when you save that grade along with a still in the Gallery and then apply that grade to another shot.

**Disabling Individual Nodes**

Disabling a single node is useful for temporarily disabling adjustments that you don’t think you want to use but don’t want to discard (however you should remember that it’s alarmingly easy to inadvertently turn these nodes back on again). It’s also good for giving your client a before and after preview of the last adjustment.

**To toggle individual nodes off and on, do one of the following:**

- Click the number of any node in the node graph to disable that node by itself.
- Select a single node, and choose Color > Nodes > Enable/Disable Selected Nodes (Command-D).
Disabling Multiple Nodes All At Once

If you select more than one node in the node tree, using any of the methods of turning nodes off and on described above (including Command-D) will toggle Enable/Disable Selected Nodes. Please note that the current node outlined in orange is always considered to be part of the selection.

This makes it easy to do before/after comparisons of any combination of nodes doing complicated adjustments by selecting them, while leaving un-selected nodes doing base adjustments that you want to leave enabled alone.

Disabling All Nodes

In addition to the Bypass All Grades command, disabling all nodes of a grade at once is another easy way of disabling a grade to provide a before and after of the original state of the clip (or the color managed state of the clip if Resolve Color Management (RCM) is enabled). More importantly, it’s a good way to disable all nodes of a grade in preparation for walking your client through each operation in that grade node by node, as you turn each node on in turn while narrating how it’s improving the image.

To turn every node off and on at once, do one of the following:

– Choose Color > Nodes > Enable/Disable All Nodes (Option-D) to toggle all nodes off and on.

IMPORTANT

When you turn every node off and then on again, every node is re-enabled, even nodes that had previously been individually disabled.

Turning Grades and/or Fusion Effects Off

The Bypass Color Grades and Fusion Effects button/drop-down commands in the Viewer’s title bar are also available via View > Bypass Color and Fusion menu commands. Turning off Fusion effects in the Color page is an easy way to improve playback performance on low power systems when you just need to make a quick set of grading adjustments. Toggling grades off and on is also a convenient way to quickly get a before and after look at a shot where the before goes all the way back to the source.

If you choose Toggle Bypass or click the Viewer control, you’ll turn off whatever is checked in the optional menu, which lets you choose whether or not you want to bypass both Color and Fusion, or just one or the other.

(Left) Menu commands for bypassing Color and Fusion, (Right) Edit page Timeline Viewer controls
Resetting Nodes

If you’re dissatisfied with your current operations and want to start over, there are three ways you can reset nodes in the Node Editor. These are available as items in the Color menu.

– **Reset Selected Node Grade:** Resets the currently selected node, eliminating all keyframes, to the default parameter settings.

– **Reset Grades and Keep Nodes:** Resets every node in the current node tree, without affecting the node tree’s structure; all nodes remain where they were. However, each node has been reset to the default parameter settings.

– **Reset All grades and Nodes:** Deletes every node and keyframe, and restores a single node set to the default parameter settings.

You can also reset nodes using the mouse, which can be a quick thing to do if you’re already working in the Node Editor to accomplish other things.

**Methods of resetting nodes with the mouse:**

– **To reset a selected node:** Right-click that node and choose Reset Node Grade from the contextual menu.

– **To reset all grades and nodes:** Right-click anywhere in the background of the Node Editor, and choose Reset All Grades and Nodes from the contextual menu.

**Methods of resetting nodes with the keyboard:**

– **To reset a selected node:** Press (Shift-home).

– **To reset all grades and nodes:** Press (Command-home).

– **To reset all grades and keep nodes:** Press (Shift-Command-home).

Previewing and Restoring Node Trees

There are two other methods of quickly dealing with unwanted changes you’ve made to node trees, without needing to use undo.

– **Preview Memory:** Lets you preview the effect of any saved grade on the current clip. To preview, choose Color > Preview Memory (Option-Shift-P), and then right-click any saved still in the Gallery (or Memory) and choose Add Correction. In fact, you can use Add Correction to try out as many stills as you like. If you like any still’s effect, then you can leave it be. If you don’t like any of the stills you previewed, then choosing Color > Preview Memory again reverts the clip to the original grade.

– **Original Memory:** This command lets you quickly revert a clip’s grade to its original state when you first selected that clip. It is accessed by choosing Color > Original Memory (Option-Shift-O). This is useful for getting immediately back to a clip’s original grade if you’ve made a series of changes that you then regret. Selecting another clip in the Timeline and then reselecting the clip you made changes to resets what is considered to be the current grade.
Caching Specific Nodes to Improve Performance

You can flag specific nodes to be cached, along with all nodes appearing upstream in that node tree. By caching nodes using processor-intensive effects, you free up real time capability for the remaining downstream nodes in a grade. Choosing Playback > Render Cache > User only caches nodes that you’ve flagged for caching.

When you choose Playback > Render Cache > Smart mode, DaVinci Resolve automatically caches any nodes that use Motion Blur, Noise Reduction, or OFX plug-ins, without you needing to do anything.

To flag a node and all corrections made in upstream nodes for caching:
– Right-click any node and choose Node Cache > On from the contextual menu.

Editing Node Trees

There is no limit to the number of nodes you can create and connect to one another, and you can make as many or as few parameter adjustments as you like within each node. The following procedures describe the ways you can add nodes to the node graph as you build each grade’s node tree.

Adding Nodes

The simplest thing you can do to add to the complexity of a node tree is to add additional nodes, in order to add more adjustments to the current grade. You can add nodes so that they’re automatically attached to nodes that are already in the node tree, for immediate adjustment, or you can add unattached nodes to empty areas of the node tree in preparation for assembling a particularly complicated and specific node tree to accomplish a difficult task.

Methods of adding nodes to the tree using a mouse, tablet, or trackpad:
– To add any kind of node to the node graph using the mouse: Right-click any node in the node tree, and choose the type of node you want to add from the Add Node submenu of the contextual menu.
– To add a disconnected node to the node graph: Right-click anywhere within the node graph’s background, then choose Add Node > Corrector from the contextual menu. Disconnected nodes have no effect on a node tree until they’re connected.

Methods of adding nodes to a currently selected node in the tree using the keyboard:
– To add a serial node after the currently selected node: Press Option-S key, choose Color > Nodes > Add Serial from the menu.
– To append a serial node to the very end of the node tree: Press Option-K, choose Color > Nodes > Append Node from the menu.
– To add a serial node before the currently selected node: Press Shift-S, or choose Color > Nodes > Add Before Current.
– To add nodes in parallel to the currently selected node: Press Option-P, choose Color > Nodes > Add Parallel from the menu.
– To layer nodes with the currently selected node: Press Option-L, choose Color > Nodes > Add Layer from the menu.
– To add an outside node to the currently selected node: Press Option-O, choose Color > Nodes > Add Outside Node from the menu.
Adding Nodes with Windows Turned On

There are also dedicated commands for adding serial nodes with Circular/Linear/Polygon/Curve windows automatically turned on, for convenience.

To add a node to the tree with a Window automatically enabled:
Choose an item from the Nodes menu that corresponds to the following:

- Node + CPW: Circular Power window (Option-C)
- Node + LPW: Linear Power window (Option-Q)
- Node + PPW: Polygonal Power window (Option-G)
- Node + PCW: PowerCurve window (Option-B)

Whenever you add a node to a tree, it’s numbered consecutively to come after the next most recent node you’d added, regardless of the order in which it appears in the node tree. For example, if you’ve already added three nodes, and then you decide to add another node in between Nodes 1 and 2, the new node will be Node 4, and the order of the nodes will be 1, 4, 2, and 3.

Deleting Nodes

If there’s a node that you no longer need, you can choose to remove it completely from the node tree to remove its effect permanently.

To delete a node, do one of the following:

- Select a node, then press the Forward-Delete key.
- Right-click a node, and choose Delete Node.

After you’ve deleted a node, the node to the left and right of the node you deleted are automatically connected so that the node tree is unbroken. Also, all the nodes in a tree are renumbered after the deletion of any node, so there’s no discontinuity in node order. For example, if you have three consecutively numbered nodes in a tree and you delete the second one, the node that was formerly number 3 is renumbered to be 2.

Connecting and Disconnecting Nodes

For a node tree to work, every node in the Node Editor must be connected into a working node tree, from the Source input, through each node in the tree, to the Node Tree output. Any disconnected node will result in that clip’s grade being disabled. However, you may find the need to disconnect some parts of a node tree in order to reconnect them in different ways.

To connect two disconnected nodes:

- Click and drag a connection from the RGB or key output of one node to the corresponding RGB or key input of another, and when the line highlights, release the mouse button.

To change the connection from one node to another:

- Move the pointer over the second half of any connection line between two nodes until it highlights blue, then click and drag it to reconnect it to another input, on that node or another.

To disconnect two nodes, do one of the following:

- Position the pointer over the right-hand side of a node connection so it highlights, and click it to delete it.
- Click a link to select it (selected links turn orange), and then press the Delete or Forward-Delete key.
- Right-click a link and choose Delete Link.
To overwrite a node’s previous connection:

- You can drag a connection to a node input or output that’s already connected, which will overwrite the previous connection with the new one you’re dragging. When you do this, the connection that’s about to be overwritten appears highlighted in orange.

- You can connect any node’s RGB or Key output to as many inputs as you want, but you can only have one connection going to a node’s input. The exception to this is a node with multiple inputs, designed to combine the output of multiple nodes. These include the Parallel, Mixer, and Key Mixer nodes.

Extracting a Node

Sometimes you need to remove a node from its current position in the node tree, such that the nodes to the left and right of it automatically reconnect to one another, saving you from having to reconnect them manually. This is called extracting a node.

To extract a node, do one of the following:

- Select a node, and choose Color > Nodes > Extract Current Node.
- Select a node, and press E.

Keep in mind that disconnected nodes in the node tree suspend grading altogether, so you’ll want to either reconnect that node to another part of the node tree, or delete it; you cannot leave it disconnected in the Node Editor.

Inserting a Node

If there’s a disconnected node in the Node Editor, there’s a simple way you can insert it into the node tree between any two other nodes. This also works for nodes that you’re dragging into a node tree from another source, for example, from the exposed node tree of a still in the Gallery.

To insert a disconnected node between two other nodes:

- Drag a disconnected node, or a node from another node tree, onto the connection between any two other nodes in a node tree; when a plus icon appears over the node you’re dragging, drop it to insert the node.

Rearranging Node Order

The order in which nodes are connected in your tree affects the result of a grade. For example, if you boost the highlights in the first node, and then you try to isolate a portion of the picture in a second node that you now realize has been clipped, you may need to change your order of operations to optimize your corrections.

To swap the contents of two nodes:

- Command-drag any node and drop it onto another node to swap the operations within each node. The nodes won’t appear to have moved, but you should be able to tell from the node badges underneath that the operations have been reversed.

To move a node to any other position in the node tree:

1. Double-click any node in the node tree and press E to extract it, removing it from the tree so that it becomes unattached.

2. Drag the now-unattached node to the connection line between any two other nodes in the tree, and when a small plus icon appears, drop it to automatically connect that node at that position in the node tree.
Copying and Pasting All Settings From One Node to Another

The simplest thing you can do is to copy all of a node’s settings and paste them into another node. This makes it easy to duplicate things like windows, qualifier settings, keyframing, or motion tracking that you want to reuse in another node as the basis for another operation. This is also a quick way to manually ripple a change you make in a node to that same node in another clip’s grade.

To copy a node’s settings from one clip to another, do one of the following:

– Option-drag one node onto another. When you drop it, the settings of the node you dragged overwrite those of the node you dropped onto.
– Select a node with settings you want to copy and choose Edit > Copy (Command-C). Then, select a node you want to paste these settings to either in the current grade or in the grade of another clip, or create a new node, and choose Edit > Paste (Command-V) to paste the settings you copied. These pasted node settings overwrite any other settings that node previously used.

NOTE: There are additional methods of copying nodes and individual node settings. For more information, see Chapter 139, “Grade Management.”

Keeping Node Trees Organized

It’s a good idea to keep the arrangement of your nodes in the node graph clean and neat. It’ll make it easier to read your tree if you need to revisit a grade later on, and it will also make it easier for other colorists working on the same project to figure out what you’re doing. The following procedures describe how to rearrange the nodes in your tree, and the node tree working area, to help you keep on top of your grades.

To move nodes within the Node Editor:

– Drag any node to a new position.
– Command-click or drag a bounding box around multiple nodes that you want to move, and drag them all to a new position.

Of course, it’s easy to get carried away. If you’ve been working furiously on a complex grade and you find yourself staring at a riot of disorganized nodes, it’s easy to quickly reorganize your node graph using a pair of commands in the Node Editor contextual menu.

To clean up the node graph, right-click the Node Editor and choose:

– Cleanup Node Graph: Moves all nodes in the node graph so they appear in an evenly spaced grid. Connection lines are routed around nodes to minimize clutter.
Using Compound Nodes

Another node structure you can use to keep complex node trees organized is the compound node. You can Command-click to select any number of nodes in the node tree (selected nodes are highlighted white), and then use the “Create Compound Node” command to nest all selected nodes inside of a single node.
Before/after creating a compound node

The resulting compound node that’s created has as many inputs and outputs as are necessary to accommodate the connection lines that attached the nodes you selected to the rest of the node tree.

You can use compound nodes to organize complicated node trees by nesting sets of nodes that work together to do a specific thing within a single node. You can also turn a set of nodes that you’re using to create a specific effect into a compound node in preparation for saving to the Gallery. Creating a library of effects in this way makes it easy to reuse them via the Append Grade command, without the undue burden of adding lots more nodes to your grade later on.

Methods for creating and working with compound nodes:

- **To create a compound node:** Command-click each node you want to nest inside of a compound node to select them with a white highlight, or drag a bounding box around a group of nodes. Then, right-click one of the selected nodes, and choose Create Compound Node from the contextual menu.

- **To edit a compound node:** Either hold the Command key down while double-clicking the compound node you want to open, or right-click any compound node and choose Show Compound Node from the contextual menu. The contents of that node appear in the Node Editor, taking the place of the overall node tree.

- **To exit a compound node you’re editing:** To return to the top level node tree, double-click the leftmost item in the path control at the bottom of the Node Editor, or click the name of the compound node. You can also right-click in the compound Node Editor and choose “Exit Compound Node” from the contextual menu.

- **To label a compound node:** Right-click a compound node, choose Change Label from the contextual menu, and type a new label for that node. Press the Return key when you’re finished.

- **To decompose a compound node:** Right-click the compound node you want to decompose, and choose “Decompose Compound Node” from the contextual menu. The compound node disappears, replaced by the original nodes within. Please note, if you had applied an adjustment to the compound node itself, that adjustment is lost when you decompose it back into its constituent nodes. If you want to preserve the compound node adjustment itself, you can copy it, then decompose the node, and then create a new node and paste the adjustment you’d copied.
Adding Inputs and Outputs to Compound Nodes

When you open the contents of a compound node using the Show Compound Node command, you can make whatever adjustments you like to the node tree within, but you also have the option of right-clicking within the Node Editor and choosing Add Source to add an input to the compound node, or Add Output to add an output. Adding more inputs and outputs lets you set up the node to connect to the rest of your node tree in more complicated ways. Disconnected inputs and outputs have no effect on your grade.

Furthermore, you can also use the Add Alpha Source and Add Alpha Output contextual menu commands to add KEY inputs and outputs to a compound node, making it easy to route key or alpha channel data to other connections in the enclosing node tree.

Nesting Compound Nodes

Compound nodes can also be nested within other compound nodes, if necessary.

Grading Compound Nodes

After you’ve created a compound node, you can select it to make one or more adjustments using the compound node itself, which effectively adds those adjustments after all other adjustments that take place via the nodes that are inside of the compound node. This gives you the opportunity to “trim” the effect that compound node is having on your grade, or to limit it using a qualifier or window.

To adjust the individual nodes nested within a compound node, you need to first open the compound node. Then, you can select and adjust any node as you ordinarily would.

Identifying Nodes

As you make various adjustments to nodes, small badges appear underneath that indicate what each node is actually doing. Since nodes are capable of holding multiple adjustments, any given node may have multiple badges; how many badges a node can show depends on the zoom level of the Node Editor. Larger nodes will show more badges, whereas smaller nodes will show fewer badges, hiding whichever badges don’t fit.

Another nice organizational feature of the Node Editor is an automatic tooltip that appears whenever you hover the pointer over a particular node, that shows you a concise list of all the operations applied to that particular node.
Putting Nodes into HDR Mode

When using various grading controls in the Color page to grade wide-latitude images for HDR output, you may find it useful to enable the HDR mode of the node you’re working on by right-clicking that node in the Node Editor and choosing HDR Mode from the contextual menu.

This setting adapts that node’s controls to work within an expanded HDR range. Practically speaking, this makes it easier to work with wide-latitude signals using controls that operate by letting you make adjustments at different tonal ranges such as Lift/Gamma/Gain, Custom Curves, Soft Clip, and so on.

Clip vs. Timeline Grading

Ordinarily, the Node Editor has two modes. The default Clip mode lets you create individual grades for each clip or group in the Timeline. However, the Timeline grade mode lets you apply a single grade simultaneously to every clip in the Timeline, as seen in the Thumbnail timeline in the following screenshot.

There are a variety of reasons you might want to do this. For example, if you’re working on a commercial spot, you might elect to use Clip grades to do general correcting and scene-to-scene balancing, and then use the Timeline grade to apply a single stylistic grade to the entire spot simultaneously. That way, any changes the client wants made to the style of the grade can be instantly applied to the whole spot.

Another example would be using the Timeline grade to apply corrections meant to address QC issues running throughout a program, desaturating highlights or selectively darkening a specific shade of red wherever it appears.
To switch between Clip and Timeline grading modes:

- Choose the mode from the drop-down menu at the top right of the Node Editor.

![Selecting Track mode in the Node Editor](image)

- Click the dot in the Node Editor toolbar that corresponds to the Clip or Timeline mode

![Two dots show whether you're in Clip or Timeline mode; these can be clicked to switch](image)

**NOTE:** When you reset the Timeline grade using the Color > Reset All Grades and Nodes command, the Output Sizing parameters are reset as well.

Two dots at the top of the Node Editor let you switch between Clip and Timeline modes via a single click. If you’re working on a clip that’s part of a group, four dots will be displayed to allow fast access to the Pre-Clip and Post-Clip Group modes as well. For more information about group grading, see Chapter 139, “Grade Management.”

**Timeline Grades and Saved Stills**

When you save a Gallery still, the Clip and Timeline grades are both saved. However, when you apply a grade from that still, you only apply either the Clip grade, or the Timeline grade, depending on which mode the Node Editor is in. For more information on saving and applying grades, see Chapter 139, “Grade Management.”
Chapter 141

Image Processing Order of Operations

The addition of the HDR palette and Color Warper in DaVinci Resolve 17 necessitated an updated diagram of the order of all image processing operations in DaVinci Resolve, from input through output. A truly detailed breakdown now requires two charts as detailed in this chapter; the first chart details the overall order of operations taking place on every page, while the second zooms into the specific order of operations occurring within each node of the Pre-Clip, Clip, Post-Clip, and Timeline grades that you create on the Color page. Understanding the order of operations presented here will make it easier for you to control the power of the full DaVinci Resolve toolset.

Contents

Overall Image Processing 2810
Image Processing Within Grades 2811
Overall Image Processing

In the following chart, each image processing operation in DaVinci Resolve is shown in the order in which it’s processed. Operations are color-coded to indicate the page on which those controls appear, because in many cases page order does not determine image processing order. Why? Either to make sure each operation is processed as cleanly as possible, or to give the user the maximum control over the image. For both of these reasons, image processing order is carefully considered, and in some cases the best result requires operations on different pages to alternate with one another.

Most of the time, this order of operations is irrelevant to the user who’s only interested in the end result. However, if you’re trying to achieve something very specific, or if you’re wondering why you see a particular result when you use the features of the Cut, Edit, Fusion, and Color pages together all at once, this chart should help make things clear. Finishing artists in particular should find this chart illuminating.
Image Processing Within Grades

For Pre-Clip, Clip, Post-Clip, and Timeline grades on the Color page, most Color page operations are available within each Corrector node you add to the Node Editor. Within each node, these operations take place in the following specific order.

The order of image processing operations that takes place within each Corrector node in the Color page

Thanks to the modular operation of the Node Editor, if a pair of image processing operations you need to use isn’t in the ideal order for what you’re trying to do, you can apply each operation using two different nodes in order to force those operations into the order you want. Similarly, when using Layer, Parallel, or Key mixer nodes, the order of operations can be seen in the visible arrangement of nodes in your node graph.

That said, most colorists tend to spread different operations across multiple nodes, whether they need to or not, for organizational purposes or to “sandbox” certain volatile decisions that might need to be independently revised later. However, nothing’s keeping you from using multiple operations within a single node if you prefer a simpler node structure for your grading. Thanks to the flexibility of the Color page, it’s your choice.
This chapter covers the four fundamental node structures you can use to combine Color page adjustments in even more detailed ways. These methods let you control your order of operations and re-combine multiple versions of the graded image in much more specific ways.

Contents

Serial, Parallel, and Layer Node Tree Structures
Serial Node Structures
Controlling What Feeds a Node’s RGB Input
Parallel Node Structures
Layer Mixer Node Structures
Layer Mixer Prioritization
Using Composite Modes With the Layer Mixer
Adjusting Layer Node Strength Using Key Output Gain
Converting Layer Mixers to Parallel Mixers
Serial, Parallel, and Layer Node Tree Structures

There are several ways you can organize nodes in a tree. Each method lets you control a group of image processing operations in different ways to achieve specific results. This section covers how to use Serial nodes, Parallel nodes, and Layer nodes, as well as how to use LUTs, work with HDR media that lets you combine two different exposures using two different Source inputs, and apply additional project-wide adjustments using the Timeline grade.

Serial Node Structures

The simplest, and most common node structure is a serial cascade of nodes, where a linear series of nodes is connected, one after another.

Much of the time, this method of constructing a tree of multiple operations is all you need to do. It’s a simple and intuitive way of organizing your adjustments, similar in principle to the stacks of layers used in other grading and compositing applications to apply multiple operations to a clip.

Controlling What Feeds a Node’s RGB Input

When you create a grade using serially arranged nodes, each node’s output is used as the next node’s input, so the order in which the nodes are arranged determines the order of image processing operations.

In the following screenshot, the node tree shows a series of three operations that are applied to a log-exposed, low-contrast clip. The first node expands clip contrast and increases saturation. The second node isolates the sky to intensify its color. The third desaturates and warms the image. At right, you can see the result of this node tree.

Node 2 pulls a clean key from the image data fed it by Node 1

If, instead, we reversed the order of Nodes 2 and 3, the result will be a less effective key.

By comparison, Node 3 pulls a less than optimal key from the image data fed it by Node 2.
Because the secondary operation is sampling the desaturated image, rather than the source, the HSL Qualifier’s key has less image data to work with, and thus you may get an inferior result.

**Parallel Node Structures**

Another way to organize your corrections is to use a Parallel node structure, which lets you apply two or more overlapping adjustments at a single stage of a node tree. You can use the Parallel node structure for organizational reasons when there is a group of secondary corrections that you want to apply all at once. You can also use this structure for the unique way it blends overlapping image adjustments.

The Parallel Mixer node that makes this possible has multiple RGB inputs and a single RGB output. This lets the Parallel Mixer mix together multiple Corrector nodes, outputting a single image as a result.

When you add a Parallel node to an existing node, DaVinci Resolve automatically adds one Corrector node below the current node, and adds a Parallel Mixer node to its output.

![Adding a Parallel node to Node 2 automatically adds the Parallel Mixer](image)

**TIP:** If you want to create a series of Parallel nodes that connect to the output of the currently selected node, create a Serial node before you create your first Parallel node.

If you’re manually connecting another node to a Parallel Mixer node, you must first create an additional input to connect it to.

**To create an additional, unconnected input on a Parallel Mixer node:**

– Right-click a Parallel Mixer node and choose Add One Input.

Ordinarily, the RGB input of every Corrector node that’s connected to a Parallel node is connected to the output of the same node. This results in a stack of nodes that take the same state of the image as their input. This makes it easy to apply multiple secondary operations without worrying about whether or not a change to one will affect the keys of the others.
Further Parallel nodes can be added as you wish with each using a common source.

If you add another node in parallel, the Parallel Mixer automatically adds another input. You can have as many nodes in parallel as you need.

The adjustments made by all nodes that are connected to a Parallel Mixer are combined equally, regardless of which nodes are highest. In the following example, a separate overlapping window is applied by each of three nodes in parallel.

As you can see in the image at right, the three tints created by the overlapping windows are all mixed together equally; the colors blend with one another as if they are optically mixed. Most of the time, this is exactly what you want when you’re blending overlapping naturalistic color adjustments.

**Converting Parallel Mixers to Layer Mixers**

On the other hand, if you need your overlapping color adjustments to have priority over one another, or if you want to combine multiple adjustments using composite modes, then you may want to use the Layer Mixer node instead. If you’ve created a Parallel Mixer structure and you want to convert it to a Layer Mixer, you can.

**To change a Parallel Mixer node into a Layer Mixer node:**

- Right-click a Parallel Mixer node and choose Morph Into Layer Mixer Node.
Layer Mixer Node Structures

The Layer Mixer is structurally quite similar to the layout used by the Parallel Mixer. However, there are two key differences. First, the Layer Mixer node combines multiple adjustments with priority given to the image adjustment in the lowest overlapping node input. Second, you have the option of combining all of the Corrector nodes that are connected to a Layer Mixer using one of several different composite modes, to create a wide variety of visual effects.

Because of their similarities, layering nodes with the Layer Mixer works in much the same way as creating a Parallel node structure.

Layer Mixer Prioritization

In the following example, the same node structure from the Parallel Mixer example is shown, this time with the three overlapping color adjustments mixed together using the Layer Mixer.

Now, instead of the three adjusted color tints being blended, you can see that the blue tint, which is connected to the lowest input of the Layer Mixer, is dominant and covers the overlapping regions of the two other adjustments. Meanwhile, the green tint, which is connected to the middle input of the Layer Mixer, covers the overlapping portion of the orange tint, which is connected to the highest input of the Layer Mixer.

Rearranging which connections are attached to which Layer Mixer inputs changes each node’s priority, and like the Parallel Mixer, you can add more inputs if you need to connect more nodes manually.

The Layer Mixer’s prioritization is most useful when you have an overlapping adjustment that you need to override any other adjustments happening on that stack. In the following example, two nodes are connected to the Layer Mixer node. Node 2 is applying a high-contrast, cool look to the entire clip. Node 3 isolates the skin tone, which is unflattering with the background stylization, and applies a different, more naturalistic adjustment.
Using the layer mixer, grades on Node 3 will have a greater priority over Node 2, so the final grade combines the high contrast from Node 2 with the adjusted skin tone from Node 4.

Because of the Layer Mixer’s prioritization, the adjustment made to the woman’s skin tone completely covers the adjustment made to the node that comes above it, providing the best of both worlds with one simple adjustment.

**TIP:** If you want to “solo” overlapping nodes that are connected to the Layer Mixer to see their individual adjustment, turn on Highlight (Shift-H, or the HILITE button on the DaVinci Resolve Mini Panel, or at the bottom of the T-bar panel of the DaVinci control panel). This lets you view just that node’s effect, regardless of what other node adjustments are overlapping.

### Using Composite Modes With the Layer Mixer

You have the option of combining the adjustments made by all nodes connected to a Layer Mixer node using the same Composite modes that are available when compositing clips in the Timeline. This lets you combine different overlapping image adjustments using compositing math to achieve creative effects or utilitarian fixes.

The following simple example shows two overlapping Corrector nodes connected to a Layer Mixer node that’s set to the Add composite mode. Node 3 has no adjustment, but Node 5 has an extremely high-contrast curve adjustment applied, along with a blur, that effectively isolates the highlights of the image and feathers them out.

[Diagram of nodes connected using Add composite mode]

Combining two nodes using the Layer Mixer set to Add to create a glowing effect.
By adding both treatments together, a hot glow has been created, blowing out the highlights of the image. Many, many other effects are possible using the different composite modes that are available. For more information on composite modes, see Chapter 51, “Compositing and Transforms in the Timeline.”

**Adjusting Layer Node Strength Using Key Output Gain**

Whether you’re combining overlapping corrections, or mixing different adjustments using Composite modes, you’ll run into situations where you want to reduce the influence of one overlapping adjustment relative to the other nodes that are connected to the Layer Mixer node. This can be accomplished using each overlapping node’s Key Output Gain parameter, located in the Key palette.

![Using the Output Gain parameter in the Key palette](image)

Key Output Gain defaults to 1.00, but lowering this value reduces the strength of that node’s contribution to the Layer Mixer. Using the previous example, selecting Node 4 (the high-contrast image used to create the glow), opening the Key palette, and reducing the Key Output Gain parameter to 0.50 reduces the intensity of the Glow effect by half.

You can use Key Output Gain to mix the proportion of any number of overlapping adjustments in order to create the perfect combination for your purposes.

**TIP:** You can also use the Key Output Gain parameter to mix the proportion of adjustments being combined using the Parallel Mixer node.

**Converting Layer Mixers to Parallel Mixers**

You can easily convert a Layer Mixer to a Parallel Mixer should you discover that you need to mix your overlapping corrections evenly rather than combine them with priority. Keep in mind that you’ll lose the ability to use Composite modes.

**To change a Layer Mixer node into a Parallel Mixer node:**

- Right-click a Parallel Mixer node and choose Morph Into Parallel Node.
A key is the actual image channel that’s generated by different secondary operations to isolate specific portions of images to work on. This chapter covers different ways you can manipulate and combine keys from multiple nodes, or propagate keys among nodes. It also shows different ways you can use mattes that are imported from other applications, as well as how to use the Key palette to further manipulate keys in different ways.

Contents

Introduction to Manipulating and Combining Keys 2820
Outside Nodes 2820
Feeding Keys From One Node to Another 2821
Connecting Key Outputs to RGB Inputs, and Vice Versa 2823
Using External Mattes 2824
External Mattes to Limit Adjustments 2825
Extracting External Mattes from OpenEXR Layers 2827
Using External Mattes to Add Texture 2828
Using External Mattes to Create Transparency 2829
Key Palette Controls for the External Matte Node 2830
Using Mattes From the Fusion Page 2831
Using the Key Mixer 2833
Adding Two Keys Together 2833
Subtracting One Key from Another 2834
Adding Inputs to Key Mixer Nodes 2837
Using the Key Palette 2837
Using the Key Palette to Affect Corrector Nodes 2838
Using the Key Palette to Adjust Key Mixer Controls 2839
The Many Uses of Key Output Gain 2840
Introduction to Manipulating and Combining Keys

Each node’s key input and key output makes it possible to route key channel data from one node to another so you can apply isolated corrections. Furthermore, the Key Mixer lets you combine a variety of keys from different nodes to create more detailed keys with which to tackle complex operations. This section covers all the ways you can recombine key data, as well as how keys can be used in conjunction with the Alpha output to create regions of transparency in a clip for compositing right within DaVinci Resolve.

Outside Nodes

Whenever you use a Power Window or HSL Qualifier to limit a correction within one node, a special node structure lets you automatically create a second node, called an Outside node, to apply additional adjustments to the inverse of the region you isolated in the previous node. Outside nodes are really just Corrector nodes with the Key Palette’s Key Input Invert control enabled, which makes it easy to apply separate corrections to an isolated subject and to its surroundings.

To add an Outside node to a node, creating a secondary correction:

1. Select a node that has been limited using a Power Window or HSL Qualifier.
2. Do one of the following:
   – Choose Nodes > Add Outside (Option-O).
   – Right-click a node choose Add Outside Node.

A new node is created immediately after the selected node, with the RGB and key outputs of the first node automatically connected to those of the new node.
When selecting the new node and opening the Key palette, you can see that the Key Input’s Invert control is on by default, which is what inverts the key from the previous node.

The Key Input Invert control is on by default for each node.

If, instead of using the Outside node to invert the incoming key, you want to copy the existing key in order to perform another operation to the same isolated region, you can disable the key input’s Invert control.

### Feeding Keys From One Node to Another

One of the most powerful aspects of the Node Editor is the ability to create keys based on a specific part of the node tree, and feed the result into a completely different correction somewhere else in the node tree. This is one of the reasons for the separate key input and output on every Corrector node.

The key that’s created whenever you use the HSL Qualifier, create one or more windows, or use an external matte can be output from one node’s key output and fed to the key input of any other node in a tree. There are many reasons to do this, but the following example shows a common problem you can solve with this technique.

**Using a key from one node to make an adjustment with a different node:**

1. Use Node 1 to apply a basic primary correction, increasing contrast and balancing the color to achieve a pleasing ambient color temperature.

2. Add a Serial node (Node 2), followed by a Layer Mixer node which also adds Node 4 (as seen in the following screenshots). Then, completely desaturate Node 4 and add contrast to make it super-high contrast black and white, desaturate Node 2 just a bit, and right-click the Layer Mixer node to choose the Overlay blend mode with which to combine these two layers.

The result is a highly stylized image, but the skin tone on the actor’s face and hands in the resulting image are too monochromatic, and you want to give them some differentiation. Simply adding another node after the Layer Mixer and keying the skin tone may not work well because the low level of saturation will make a key difficult to pull.
3 Add another node after the Layer Mixer (Node 5 in the screenshot), and then right-click in the gray background area of the Node Editor, and choose Add Node > Corrector to create an unattached node, (Node 6).

4 Connect the RGB output of Node 1 to the RGB input of Node 6, and then connect the key output of Node 6 to the key input of Node 5. Now you’re ready to pull a high-quality key from the very first correction in Node 1, skipping all the complication coming afterwards.

5 Use the HSL Qualifier in Node 6 to pull a good strong skin tone key based on the primary image. Given the way the node tree is now set up, that key is fed to Node 5, and will limit whatever adjustments you make there.

6 Now, you can make your adjustment to Node 6’s grade, to lower the contrast, brighten, and increase the saturation of the actor’s skin tone. As a result of this operation, the background remains desaturated and contrasty, while the actor’s skin tone has the brighter quality we need for the shot.
This example could have been handled in a variety of different ways, but the point is that you can add nodes that connect to the state of the image at any part of a node tree, and use them to generate keys to feed to any other node, regardless of what’s happening to the picture in between.

## Connecting Key Outputs to RGB Inputs, and Vice Versa

There’s another way you can manipulate a key from one node using another in the Node Editor, and that’s to connect the key output from one node to the RGB input of another node. When you do this, you can use any of the controls of the second node to manipulate the key, and you can then use the result by connecting the RGB output of the second node to the key input of a third node.

In the node tree shown above, Node 2 pulls a key, Node 4 manipulates the key, and Node 3 uses the key to make a color adjustment.

Keep in mind that a key is just a grayscale image. Setting up this kind of node structure lets you use any of the second node’s controls, such as the Custom Curves, Noise Reduction or Motion Blur controls, Sharpen, Midtone Contrast, Lift/Gamma/Gain, Contrast, or Log controls, to manipulate the key in ways you couldn’t do using only the Matte Finesse controls.

While this technique may not be necessary for conventional color isolations, it can come in very handy when making tricky isolations with hard to key subjects, or when using one of the Qualifier modes to pull a key to create transparency for compositing using the Node Editor’s Alpha output. In this instance, you can connect the RGB output of a node used for key manipulation directly to the Alpha output. In the example, Node 1 pulls a key, and the RGB is connected to Node 3 which is used to color correct the foreground image. The key from Node 1 is connected to the RGB of Node 2, which manipulates the key to clean it up prior to connecting it to the Alpha output block at the bottom right of the Node Editor.
Furthermore, this capability also lets you create keys in other ways besides using the Qualifier palette controls. In the following example, the Contrast and Custom Curve controls in Node 3 create a high-contrast matte of the windows which is blurred. The RGB output of Node 3 is then connected to the KEY input of Node 2, where the resulting key can be used for a variety of adjustments; in this case, to tint the product within the image green. Alternately, this technique could be also be used to create transparency via the Alpha output.

Interconnecting key and RGB inputs and outputs is a powerful capability that lets you create many kinds of workarounds for uncommon situations.

Using External Mattes

The External Matte node has evolved over the years. What was once purely a means for importing matte channels for defining opacity and limiting adjustments has expanded to become a way to import the RGB channels of a media file to be used for overlaying grain, texture, and stylized distress onto an image, and even as a way to use the channels of a clip itself as a matte.

Matte clips can be added to your project in one of two ways:

- You can add mattes using the Media page, either by attaching them to a clip so a particular matte is only available to a particular clip as part of a Clip grade, or you can add timeline mattes that stand alone in the Media Pool, which are then available to any Track grade.

- You can also add a matte to a clip using the Media Pool in the Color page, by dragging a clip from the Media Pool to the Node Editor. When you do so, that clip is turned into an external matte in the current grade, which you can use as a matte for secondary adjustments, or as a compositing layer (in conjunction with the Layer mixer) for mixing textures or images with your grade. That clip is also automatically attached to the Media Pool clip that corresponds to the clip you’re grading, as a clip matte, to help you keep track of which clips are using other clips as mattes.

For more information about adding matte clips in the Media page, see “Adding and Removing External Mattes” in Chapter 17, “Adding and Organizing Media with the Media Pool.”

Whether attached or unattached, mattes operate within a grade using EXT MATTE (external matte) nodes. EXT MATTE nodes have the following outputs:
An external matte connected to the first node of a grade

- **EXT MATTE Outputs**: Four blue square key outputs let you output the channels contained within the EXT MATTE node, but which channels are available affects what is output. If the EXT MATTE node’s source clip has RGBA channels, then these are available as Alpha, Red, Green, and Blue key outputs that you can attach to any other node’s key input. On the other hand, if the EXT MATTE node’s source clip only has RGB channels, then the key outputs that are made available are Y (luma), Red, Green, and Blue, and a “Use Lum for Alpha Output” setting in the Node Editor contextual menu lets you use the Y channel as a matte.

An interesting aspect of these four outputs is that each one is dedicated to individual A, R, G, and B color channels. Ordinarily, External Matte clips are written with matte data written simultaneously to all three RGB channels. However, you could also render separate pure primary-colored mattes to each color channel (a so-called “disco” matte), so that the Red channel has one matte, the Green channel another, and the Blue channels still another, thereby exporting three separate mattes within a single media file, for convenience. If you add another matte to the Alpha channel, you can then export four mattes within a single file. You can then use each one of these mattes individually by connecting the correct output of the EXT MATTE node. (Note: For backward compatibility, projects from versions of DaVinci Resolve previous to 12.5 continue to output RGBY from the square outputs, not YRGB.)

- **RGB Output**: A square green RGB output lets you connect the RGB image data of a matte clip to any other clip’s RGB input. This is especially useful when you’re combining a matte clip with the current clip using a Layer Mixer node, to create a textured composite of some kind.

**External Mattes to Limit Adjustments**

Going back to the External Matte node’s original use, mattes are typically grayscale media files that represent image opacity, and are meant to be used either as alpha channels for creating opacity within a corresponding RGB clip, or as a matte for limiting effects.

An example of a matte channel would be the key created by a green screen keyer. If you output just the key, that would be an external matte. If you receive an external matte along with an effects clip, you can attach the matte to its corresponding RGB clip in the Media page. Then, you can access that matte via an External Matte node in the Node Editor, so you can use the key it outputs to limit different kinds of corrections you want to apply.

In the following example, the keyed matte of a green screen composite clip is used to apply different corrections to the inside and outside of a keyed composite, in order to make the subject match the background more convincingly.

A matte attached to clip Makeup_Green.mov, as seen in the Media Pool
To use a clip matte to limit an adjustment within a Clip grade:

1 Right-click any node, and choose the attached matte you want to use from the Add Matte submenu of the contextual menu.

By default, the EXT MATTE node that appears has its first output connected to the Connect one of the EXT MATTE node’s triangular key outputs to the key input of a node you want it to limit.

2 Select the node to which the EXT MATTE node is attached, and add an Outside node to make it possible to add adjustments on either side of the matte.

3 If necessary, select Node 1, and use the Key palette controls to modify the incoming key, inverting or blurring it as necessary to create the isolation you need.

**NOTE:** Don’t select the EXT MATTE node, because it exposes different controls in the Key palette for transforming, flipping, looping, and freezing the matte.

At this point, you can add adjustments to the inside and the outside of this composited shot to improve the composite.

Ideally, external mattes are exported so that they match the size and duration of the RGB clip they’re supposed to accompany. If they don’t match or if you’re using some other grayscale clip as an external matte to create some sort of effect, then there are parameters in the Key palette that you can use to retime or transform a matte so it works better in your grade.
To slip the sync of a matte relative to the clip it’s attached to:
1 Select the Ext Matte node you want to slip.
2 Open the Key palette, and turn off the Lock Matte checkbox.
3 Raise or lower the Offset parameter until the matte is perfectly aligned with the clip it’s supposed to match.

To transform a matte:
1 Select the Ext Matte you want to transform.
2 Open the Key palette, and turn off the Lock Matte checkbox.
3 Use the Pan, Tilt, Zoom, Rotate, Width, Height, HFlip, or VFlip parameters to adjust the matte so it has the correct geometry.

It’s worth mentioning that you can attach as many external mattes to a single clip in DaVinci Resolve as you like. For example, if a CGI shot has been delivered with a set of isolation mattes for each of three characters in the scene, you can import all three mattes and use them to isolate adjustments that you want to make in the Node Editor.

Extracting External Mattes from OpenEXR Layers

OpenEXR media is capable of containing multiple layers and multiple alpha channels, which can also be accessed from EXT MATTE nodes. As a result, DaVinci Resolve uses a slightly different but related procedure for accessing these mattes.

To extract OpenEXR layers as external matte nodes:
1 Right-click any node, and choose the .exr clip name from the Add Matte submenu of the contextual menu.
   By default, the EXT MATTE node that appears has its first output connected to the Connect one of the EXT MATTE node’s triangular key outputs to the key input of a node you want it to limit.
2 Double-click the EXT MATTE node to select it, then right-click it and choose which layer you want to use from the Select Matte submenu.
OpenEXR files with multiple RGBA layers (or passes) embedded within them (RGBA + RGBA + RGBA and so on) or OpenEXR files with multiple alpha channels (RGBA + A + A) expose multiple entries in this submenu. Whichever one you choose is the layer that will be used as a matte by that EXT MATTE node.

Once you've extracted an OpenEXR layer, you can use it as you would any other EXT MATTE node described in this section, to limit adjustments (as seen above), or to add texture or transparency (as seen in the following sections).

Using External Mattes to Add Texture

You can also use external mattes as creative tools, to add grain and texture. For example, you might use a more abstract animated matte, or a grayscale film scan of dirt and dust, to apply correction for effect.

![Light leak and dirt and dust images](image)

Once attached to a clip, external mattes can be exposed in the Node Editor, and their key output can be used just like any other key in a node tree.

**To use a clip matte to create texture for a Clip or Timeline grade:**

1. When applying a matte as part of a Clip or Timeline grade, right-click any node and choose the attached or timeline matte you want to use from the Add Matte submenu of the contextual menu. Unattached mattes appear in the Add Matte > Timeline Mattes submenu.

2. Disconnect the EXT MATTE node's key output connection to the Key input of the node it's connected to by default.

3. Add a Layer Mixer to the end of the node tree.

4. Disconnect the bottom Corrector node's RGB input, and then connect it to the EXT MATTE node's square RGB output.

![Node tree set up to feed an EXT MATTE node's RGB output to the input of a node connected to a Layer Mixer, in order to blend it with the grade using composite modes](image)
5 Right-click the Layer Mixer node, and choose Overlay from the Composite Mode submenu to blend the Ext Matte node most effectively with the grade.

6 If necessary, you can use the grading controls of the Corrector node to which you’ve attached the EXT MATTE node to change the characteristics of the texture clip, desaturating it for instance. You can also select the EXT MATTE node itself, open the Key palette, and use the Transform, Offset, Loop, or Freeze controls described later to change how the matte appears.

![The resulting texture effect, blended with the grade using the Overlay composite mode](image)

**TIP:** If you want the texture you create to be unaffected by blur or sharpening operations within the grade, be sure to add it to the very end of the node tree.

### Using External Mattes to Create Transparency

You can also use an EXT MATTE node to create transparency in a clip, for compositing with clips underneath it on the Timeline.

**To use a clip matte to create transparency in a clip:**

1 Right-click any node, and choose the attached matte you want to use from the Add Matte submenu of the contextual menu.

   Adding an EXT MATTE node to a Clip grade applies the effect to only that clip, whereas adding an EXT MATTE node to a Track grade applies the effect to the entire Timeline.

2 Right-click any empty area of the Node Editor, and choose Add Alpha Output to reveal the Node Tree output on the right that lets you assign a key to be used to define clip transparency.

3 Connect one of the EXT MATTE node’s triangular key outputs to the Alpha output at the right of the Node Editor.

![The node setup for using an external matte to composite two layer](image)
The areas of the matte defined by the key are now rendered transparent.

The final composite created using the external matte node

Key Palette Controls for the External Matte Node

When you select an EXT MATTE node, the Key palette displays different parameters only for mattes. Be aware that you must turn off the Lock Matte checkbox before you can make adjustments to transform the matte.

![Key Palette showing a texture layer added as an EXT MATTE node](image)

- **Transform**: Standard Pan, Tilt, Zoom, Rotate, Width, and Height parameters let you transform a matte to fit the image better.
- **Flip Image**: Two buttons let you flip the matte clip horizontally or vertically.
- **Offset**: Adjust this parameter to offset the start point of a matte clip.
- **Freeze**: Turning on this checkbox freezes the matte clip on a single frame. Adjust the Offset parameter to choose which frame to freeze on.
- **Loop**: Turning on this checkbox enables matte clips to loop endlessly, which lets shorter matte clips cover longer durations.
- **Lock Matte**: When turned on, locks the sizing of a matte to whatever changes are made to the Input Sizing of that clip, so the matte transforms to follow the clip.

You can also use external mattes as creative tools. For example, you might use a more abstract animated matte, or a grayscale film scan of dirt and dust, to apply correction for effect.
Using Mattes From the Fusion Page

If you’re grading a composite that’s been created in the Fusion page, you can feed mattes created in different parts of a Fusion composition to the Color page to use in the grade as well. For example, if you’re grading a composite of a foreground actor who’s green screen keyed against a background layer, you might want to use the matte generated for the key to protect the foreground subject from an operation in your grade that you only want to affect the background. Happily, this is easy to set up.

In the following Fusion composition, two DeltaKeyer nodes (one to create an overall matte, and one to create a solid matte protecting the core) and one BSpline node (to create a garbage matte) work together to create a finely-tuned matte. This matte is used by the Merge1 node to preserve the subject’s hair and composite them in front of a gently blurred (using the LensBlur node) planet, with the final result connected to the MediaOut1 node, which feeds this image to the Edit page and Color page for continued adjustment.

A green screen composition in the Fusion page, outputting the RGB in MediaOut1, and the foreground matte in MediaOut2

Because the Merge1 node outputs the entire composition as a single image, a second MediaOut node (highlighted) is added to output the matte, just in case the colorist might want to use it later.

**TIP:** In this composition, the foreground and background images are different sizes, so outputting the alpha channel of the DeltaKeyer1 node would result in a matte sized to match the foreground image, but that doesn’t fit the composition, which is cropping the top and bottom of the foreground image based on the frame size of the widescreen background image. To get around this, the foreground and background images are composited a second time using the Merge2 node, which has the Operator parameter set to “In” to output just the foreground image and matte, as resized by the Merge operation. The resulting MediaOut2 node thus outputs a foreground matte that’s properly sized to fit the composition.
On the Color page, the grade in node 1 is applied to the overall final result, which is a single image. After grading, it’s decided that the woman appears a bit warm relative to the cool blue of the planet behind.

![Image of the Color page with a grade applied](image1.png)

The composition as it appears in the Color page Node Viewer

Right-clicking the background of the Node Editor and choosing Add Source adds a second source at the left of the Node Editor.

![Image of the Node Editor with Add Source option](image2.png)

Adding a source to bring in the MediaOut2 node’s matte output from the Fusion page composition

This second source corresponds to the second MediaOut node you added to the Fusion page composition, which outputs the Matte as a key in the Color page, usable just like any other key. If you hover your pointer over each source, a tooltip appears letting you know which output corresponds to which node.

![Image of hovering the pointer over a source](image3.png)

Hovering the pointer over a source identifies it in a tooltip

Generally, sources are arranged from top to bottom from the first MediaOut node appearing in a Fusion composition to the last. At this point, you can connect the second Source to the Key input of a second corrector node, using that key to selectively grade just the woman in the foreground (grade exaggerated for effect), without affecting the background. The Viewer is shown with Splitscreen set to Highlight Modes, so you can see the result as well as the key from the Fusion page that’s being used by Node 2.
Using the Key Mixer

The Key Mixer node lets you mix keys output from multiple Corrector nodes, combining them in different ways to create a single key output. This makes it possible to build much more intricate keys than you can with a single qualifier or set of four windows. In particular, the Key Mixer node is the only way to combine multiple keys made using qualifiers and windows, adding, subtracting, or intersecting them to create a highly specific result.

Adding Two Keys Together

In the following example, you’ll learn how to set up a Key Mixer to combine the keys output by two Corrector nodes in a node tree. Then you’ll learn how to change the way the input keys are combined using the Key palette.

To combine two or more keys using the Key Mixer:

1. Right-click anywhere on the gray area of the Node Editor, and choose Add Node > Key Mixer.

2. Create two Corrector nodes, then attach their RGB inputs to the RGB output from an appropriate node in the main part of the tree, and attach their key outputs to the key inputs of the Key Mixer.

3. Next, attach the key output of the Key Mixer node to the key input of the node you want to use to make the correction. Remember, the objective is to use the key that’s output by the Key Mixer to limit the adjustment being made using another node, in this case Node 3.

Keep in mind, especially since this is a significant reordering of nodes in the Node Editor, that every node needs to be connected properly for the overall grade to work.
Now that the node structure is fully connected, use windows, qualifiers, or both to create keys in each of the nodes that you connected to the Key Mixer. In this example, Node 2 is isolating the main skin tone, and Node 5 is isolating the blue of his jeans and hood.

By default, all keys connected to the Key Mixer are added together, as you can see in the Key Mixer's thumbnail.

If you wanted, you can use the controls in the Key palette to change this, in order to isolate the intersection of two keys, or to subtract one key from another. This is covered in the next section.

Continuing with the previous setup where both keys are added together by default, selecting Node 3 and dropping the saturation to be very faint stylizes the entire background, while leaving the various hues of the man we’ve isolated alone.

The way multiple keys are combined within the Key Mixer depends on a pair of Key Input buttons you can toggle using the Key palette. In the following example, a partial green tint is washed throughout the midtones of the image using a qualifier, but you want to exclude the man's skin tone from this operation. Using the Key Mixer, you can subtract one key from another to accomplish this with ease.
To change the Key Input settings for a node connected to a Key Mixer:

1. In this example, Node 2 is isolating part of the midtones of the image, and feeding its key through the Key Mixer to Node 4, which is using it to apply a partial blue tint. However, in preparation for subtracting the skin tone from this operation, Node 3 is isolating the man's skin tone.

2. To reveal the controls you'll use to change how the key from Node 3 interacts with the key from Node 2, double-click the Key Mixer node to select it.

3. Open the Key palette; a list of all input links that are connected to the Key Mixer appears at the right.

4. Within each list entry is the input name (Input Link 1, Input Link 2, etc.), a Matte control, a Mask control, a gain parameter, and an offset parameter.
– **To subtract Node 3's key from that of Node 2:** Turn on both the Key Input Matte button and the Key Input Invert button for Input Link 2.

![Turning on Matte and Invert for Input Link 2 to Output Node 3 subtracted from Node 2](image1)

– **To subtract Node 2's key from that of Node 3:** Turn on both the Key Input Matte button and the Key Input Invert button for Input Link 1.

![Turning on Matte and Invert for Input Link 1 to Output Node 2 subtracted from Node 3](image2)

– **To limit the output to the intersection of both keys:** Turn on the Key Input Matte button for either Input Link 1 or Input Link 2.

![Turning on Matte for Input Link 1 to output the intersection of two mattes](image3)
To invert the resulting matte you've created: Turn on the Output Link Invert button. When you're finished, if you choose to subtract Node 3’s key from that of Node 2, the result should resemble the following screenshot.

The result of subtracting a key of the man’s face from a key of the overall midtones of the image, and using that to add a selective green tint

Adding Inputs to Key Mixer Nodes

New Key Mixer nodes have two key inputs by default. If necessary, additional inputs can be added in order to combine even more keys with one another.

To add inputs to the Key Mixer:
– Right-click a Key Mixer node, and choose Add One Input.

When combining three or more keys, the interaction of keys using the Key palette controls becomes even more complex, but the rules outlined above still apply.

Using the Key Palette

For example, the Key Input Invert control is always enabled when you add an Outside node, which is why the Outside node applies adjustments to the inverse area of the previous node. If you turn this control off, that node’s key will exactly mirror the original key being fed to it from the previous node.

The controls that are available in the Key palette vary depending on what kind of node you have selected:
– **Corrector Nodes:** Have three sets of parameters. Key Input parameters let you make adjustments to keys being fed through a node’s Key Input connection. The Key Output parameters let you make adjustments to the key data being output by a node’s Key Output connection, and includes the incredibly powerful Offset Gain parameter that governs the strength of that node’s contribution to the overall grade. Finally, the Qualifier parameters let you make adjustments to the internal key created with the HSL Qualifier or Window controls. This functionality is covered more extensively in the next section.
- **Ext Mattes:** Have two sets of parameters. Transform parameters let you make geometric transformations to a matte so it fits the clip it’s being applied to better. An Offset control lets you slip the sync between an external matte and the clip to which it’s applied. This functionality is covered in the section on external mattes.

- **Key Mixer Nodes:** Have two sets of parameters that are dependent on which of the connections attached to a Key Mixer’s key inputs is selected. Input parameters let you adjust how much of a contribution a key makes to the total key mix, and whether the contribution is additive or subtractive.

The Output parameters let you adjust the inversion and strength of the key that’s output by the Key Mixer. This functionality is described more extensively in the Key Mixer section.

Layer Mixer and Parallel Mixer nodes have no adjustable controls in the Key palette.

### Using the Key Palette to Affect Corrector Nodes

When you open the Key palette for a selected Corrector node, you can adjust the following parameters:

#### Key Input Controls
- **Input invert:** Inverts the key being fed into the key input. Off by default.
- **Input matte:** Lets you switch the key input between Matte and Mask modes. In Matte mode (on by default) the key input combines via intersection with keys generated internally using the Qualifier or Windows palette. In Mask mode, the key input is added to the internal key instead.
- **Gain:** Controls the strength of the key connected to the key input.
- **Offset:** Controls the contrast of the key connected to the key input.
- **Blur Radius:** Blurs the key connected to the key input.
- **Blur H/V Ratio:** Alters the horizontal/vertical ratio of the blur that’s being applied to the key input.

#### Key Output Controls
- **Qualifier invert:** Inverts the overall key.
- **Gain:** Using the key output, this parameter governs the strength of that node’s contribution to the overall grade. Setting Gain to 0 results in that node having no effect at all, while the default setting of 1.00 applies the full strength of any adjustments made with that node. The maximum setting of 2.00 increases the intensity of any part of the key output that’s less than 100 percent white. You can also use this parameter to keyframe the key output to fade that node’s contribution in or out with one set of keyframes.
– **Offset**: Lets you adjust the contrast of the Output key. This has no effect if the entire key is 100 percent white (a solid key).

**Qualifier Controls**

– **Qualifier invert**: Inverts the key created by that node’s Qualifier palette.

– **Qualifier matte**: Lets you switch the interaction of the keys generated by the Qualifier and Window palettes between Matte and Mask modes. In Matte mode (the default), the Qualifier and Windows palettes combine via intersection. In Mask mode, they’re added together instead.

– **Gain**: Lets you raise or lower the strength of the key generated by the Qualifier palette.

– **Offset**: Lets you adjust the contrast of the key generated by the Qualifier palette.

**Using the Key Palette to Adjust Key Mixer Controls**

When you open the Key palette for a selected Key Mixer node, you can adjust the following controls:

– **Input list**: A list of every input that’s connected to the Key Mixer. Each entry on the list has the following controls:
  
  – **Input name**: The name of each node connection attached to that key mixer, such as Input Link 1, Input Link 2, and so on.
  
  – **Input invert**: Inverts the key being fed into this particular input. Off by default.
  
  – **Input mask**: Lets you switch the key input between Matte and Mask modes. In Matte mode (on) the key input combines via intersection with other inputs connected to the Key mixer. In Mask mode (off by default), the key input is added to the other key inputs connected to the Key mixer.
  
  – **Gain parameter**: Decreases or increases the intensity of that input matte’s contribution to the resulting output matte.
  
  – **Offset parameter**: Adjusts the contrast of that input matte’s contribution to the resulting output matte.
  
– **Output invert**: Inverts the overall result of the various Input Link interactions.

– **Gain**: This parameter increases or reduces the strength of the resulting output key. Setting Gain to 0 results in all inputs being set to black, while the default setting of 1.00 outputs the combined mattes at full strength. The maximum setting of 2.00 increases the intensity of any part of the key output that’s less than 100 percent white, which can have the practical effect of “growing” soft edges. You can also use this parameter to keyframe the key output to fade that node’s contribution in or out with one set of keyframes.

– **Offset**: Lets you adjust the contrast of the Output key.
The Many Uses of Key Output Gain

Several of the techniques discussed in here and in “Secondary Qualifiers,” can be further customized using the Key Output Gain parameter, which makes it easy to control the strength of a node’s effect on your grade with a single adjustment. In the following example, two simple Serial nodes are applied to a clip, with the first one expanding image contrast, and the second one using a variety of controls to add some extreme warmth to the highlights.

![Image of Serial nodes applied to a clip](image1)

A tint applied only to the highlights of the image

If you decided that you want to reduce the amount of warmth added by the second node without readjusting the controls you used to create the effect, you could open the Key palette and lower the Key Output Gain parameter to fade the effect with a single adjustment.

![Four versions of the grade shown using the Versions option of the Split Screen controls](image2)

Four versions of this grade shown using the Versions option of the Split Screen controls, with Output Gain set to 1, .75, .5, and .25 for comparison

This principle also works for controlling the strength of individual nodes that are being combined in parallel, that are combined using the Layer node, or for simply fading out the effect of any node in the node tree you want to “turn down” a bit.
Chapter 144

Channel Splitting and Image Compositing

This chapter begins by showing node structures you can use to isolate, split apart, convert, and recombine the image channels of clip in different ways. This includes ways of using the additional image channels that are provided in some types of media.

The second part of the chapter shows ways that you can do image compositing right in the Color page, with techniques for using external mattes for compositing, and using qualifier keys to do green- and blue-screen compositing against other layers in the Timeline.

Contents

- Isolating, Splitting, and Converting Color Channels 2842
- Enabling, Disabling, and Converting Node Channels 2842
- Splitting Channels with the Splitter/Combiner Nodes 2844
- Multi-Channel RED HDRx Support 2845
- Introduction to Compositing Using the Alpha Output 2848
- Using a Qualifier Key to Create Transparency 2848
- Using a Matte to Create Transparency 2851
- Use an OFX Plug-in to Create Transparency 2852
**Isolating, Splitting, and Converting Color Channels**

DaVinci Resolve provides two different methods of making channel-specific adjustments, depending on whether you need to apply an adjustment to just one channel within a single node, or apply separate adjustments to all three channels across several nodes.

**Enabling, Disabling, and Converting Node Channels**

Within the contextual menu of each node in the Node Editor is a series of four options:

![Expanded choices for choosing a color space and gamma for image processing within a node, and for disabling channels](image)

While the ability to change the color space in which a particular node’s operations work from the RGB default has been available for many versions, the list of available color spaces was greatly expanded in DaVinci Resolve 15 (all the previous options such as Lab (CIE), HSL, and YUV are still there). Additionally, you have the option of choosing the gamma that node works with as well, with a similarly long list of options.

Choosing a node-specific color space and gamma does not directly alter the image, as with the Color Space Transform ResolveFX plug-in. Instead, changing a node’s color space and gamma alters what type of image channels the red, green, and blue controls affect, and how the adjustments you make within that node are applied. For example, this lets you make a temperature adjustment with a node’s gamma set to Linear, which in some instances may be mathematically advantageous.

Additionally, three checked Enable Channel 1–3 options let you turn individual channels off or on, limiting which channel that node’s adjustments will actually affect.

In the following example, you’ll see how to use these features to selectively sharpen just the Y’ (luma) of an image without affecting the chroma, which can be a more subtle effect than simply sharpening the entire image.

**To use channel disabling and color space conversion to sharpen luma only:**

1. Add a node with which to apply the sharpening you want to the current clip.
2. Right-click the new node, and choose YUV from the Color Space submenu of the contextual menu.
Apply sharpening by doing one of the following:

- Using that node's contextual menu, uncheck Enable Channel 2 and Enable Channel 3, which correspond to the U (Cb) and V (Cr) channels, leaving only Channel 1 (Y) enabled. Then, open the Blur palette, and drag the ganged Radius sliders down to sharpen the Y channel.

- You can also just open the Blur palette, ungang the Radius sliders, and drag the red slider down to sharpen the Y channel, since any control with three gangable sliders will automatically assign those sliders to whichever channels are used by the currently selected Color Space.

As you can see, while the Blur palette ordinarily provides separate R, G, and B controls that can be unganged from one another, the Color Space submenu lets you apply sharpening to the channel definitions of other colorspaces, providing many other corrective and creative possibilities with the same controls.

**Supported Color Spaces for Conversion**

The Color space submenu available when you right-click a node in the Node Editor supports four different color spaces that you can set each node to work within. When you choose a color space other than RGB, all channel-specific controls (the Custom curves, Soft curves, RGB Lift/Gamma/Gain sliders, and RGB mixer) operate on the particular channels of that color space, rather than the default YRGB channels. By switching color spaces, you can achieve very different kinds of adjustments by swinging values among mathematically different axes.

- **YUV** converts the image into Y', Cb, and Cr channels. The Y' channel governs luminance, while the Cb and Cr are color difference channels that work within the broadcast model of color.

- **HSL** converts the image into Hue, Saturation, and Lightness channels. Lightness is identical to Luminance, while Hue and Saturation are exactly as described.

- **LAB** operates on the L, A, and B channels. The L channel governs luminance, while the A and B channels are color difference channels; A adjusts color on an axis from magenta to green, B adjusts color on an axis from yellow to blue.
Splitting Channels with the Splitter/Combiner Nodes

Another method of applying corrections to individual color channels is using the Splitter/Combiner nodes, which break the Red, Green, and Blue channels apart into separate node tree branches, each capable of accepting multiple serial and parallel nodes of image adjustment. There are two ways you can create a Splitter/Combiner node structure.

Methods of adding Splitter/Combiner nodes:
- **To add a premade Splitter/Combiner node structure**: Choose Color > Nodes > Add Splitter/Combiner Nodes (Option-Y). A Splitter and Combiner node appear already connected to three Corrector nodes, one for each color channel.
- **To manually construct a Splitter/Combiner node structure**: Right-click in any empty area of the Node Editor, and choose from the Add Node submenu to create a Splitter node, a Combiner node, and three Corrector nodes, wiring them together as necessary to create the desired effect.

The Splitter Combiner node structure

The Splitter node takes an incoming image and provides individual outputs for each color channel (top/red, middle/green, bottom/blue). When you connect each of these outputs to a Corrector node, that color channel automatically connects to all three internal channels of that node, so that the default three nodes in a Splitter/Combiner structure are internally processing red/red/red, green/green/green, blue/blue/blue. The Combiner then pulls the Red, Green, and Blue channels out of each node connected to its three inputs, and reassembles them into a single RGB image again. Of course, what happens in between the Splitter and Combiner is entirely up to you.

One of the simplest ways of showing the possibilities of this node structure is to combine it with Node Sizing in the Sizing palette. Using Node Sizing, you can correct for misaligned channels in older archived video, or create channel misalignments for creative looks. In the following example, a simple Node Sizing adjustment to a split Blue channel will create an interesting “prism vignette” effect.

**To use Node Sizing on individually split channels:**
1. Choose Nodes > Add Splitter/Combiner Node (or press Option-Y) to add a premade Splitter/Combiner node structure to the Node Editor.
2. Select the middle of the three Corrector nodes appearing in between the Splitter and Combiner nodes (Node 5 in the following screenshot).
3 Open the Sizing palette, choose Node Sizing from the Mode drop-down, and then raise the zoom parameter by a small amount; this example uses 1.014.

![Zooming just one color channel using the Splitter/Combiner nodes](image)

As you can see in the screenshot, just the Green channel has been zoomed in on across the entire image. This is only possible using Node Sizing. This is cool, but not quite what you need.

4 Open the Window palette, add a Circular window, turn on its Invert control, and transform it to be a very soft, horizontally aligned vignette. This limits the individual scaling done to the Green channel to just the outer edge of the image, similar to a lens with excessive chromatic aberration.

![The resulting channel split effect](image)

You could easily keep going, applying varying amounts of zoom with different window shapes to each of the other color channels, and perhaps adding some blur to enhance the effect, but this example should show the creative potential available when using this technique.

### Multi-Channel RED HDRx Support

The RED EPIC, SCARLET, DRAGON, and WEAPON cameras are all capable of shooting in an HDR mode that effectively “brackets” two different exposures of each frame. The resulting image data stores two channels of image data: the regular exposure, and a “highlight exposure” that’s underexposed by a user-selectable margin (+3, +4, +5, or +6 f-stops difference).

By default, the Input bar in the node graph feeds the regular exposure to your grade’s node tree. To take advantage of the additional “highlight” exposure, you can add an additional Source input to the node graph that feeds a second stream of image data that you can mix with the regular exposure in different ways.

**NOTE:** You can also take advantage of the highlight exposure of RED HDRx media by enabling and adjusting the Magic Motion controls in the Camera Raw palette.
To set up a node tree combining the normal and highlight HDR versions:

1. Using the first default node (Node 1), grade the image to see if you even need to use the alternate exposure that’s available. We’ll assume for this example that you do. In this example, the sky of the default exposure is pretty blown out, but there may be detail that can be retrieved using the highlight exposure.

2. Create a Layer Mixer node by choosing Nodes > Add Layer (Option-L).
   Two nodes are created, a Layer Mixer node that’s added after Node 1, and a third node (Node 3) that’s connected to a second RGB input of the Layer Mixer node in parallel to Node 1.

3. Right-click anywhere within the node graph (except on a node) and choose Add Source from the contextual menu.
   A second Source input appears underneath the first, which outputs the highlight exposure of the image as a separate image stream.

4. Delete the connection between the top Source input and Node 3, and then connect the bottom Source input to the RGB input of Node 3.
Immediately, the image in the node thumbnail and Viewer updates to show the darker, underexposed version of the HDR image. This is because, by default, the Layer Mixer is mixing 100% of Node 3 over Node 1.

5 Select Node 3 and use one of the following two procedures to create a useful combination of the two exposures:

To create a mix of the two exposures, open the Key tab, and drag the Key Output Gain slider to lower the contribution of Node 3 to the overall image. Using dynamics (keyframing), this is a good way to animate a dissolve from the regular exposure to the highlight exposure if you’re going from a dark environment to a bright environment in the same take and you want to create a smooth transition between both exposures.

**TIP:** You can also use the Blend Type and Blend Bias parameters in the Camera Raw palette to blend the two exposures without building a dedicated node tree.

To use the highlight exposure to selectively put detail back into the image (for example, to retrieve blown-out windows), use a Power Window, HSL Qualification, or a combination of the two to isolate the region you want to retrieve in Node 3. (Be careful if you’re using HSL Qualification to combine both exposures, as keyed edges can be tricky to blend.)
A Note About RED HDRx Media and Performance

Since RED HDRx media records two complete streams of image data, DaVinci Resolve must simultaneously decode two separate tracks whenever you add a second Source input. (If you don’t add the second Source input, only the first stream is decoded.)

Because of this, whether you’re relying on your computer’s CPU or GPU to decode RED media, you’ll get half the performance when using the highlight stream of an HDR clip.

To improve performance, you can enable the Smart Cache by choosing Playback > Render Cache > Smart. This automatically caches all raw source clips to the current codec set in the Render Cache Format parameter of the Master Settings panel of the Project Settings. Alternatively, you can enable the User Cache, and cache all HDRx clips manually by right-clicking them and choosing Render Cache Fusion Output > On. DaVinci Resolve renders all cached clips while you’re paused, so the next time you play a cached clip, it will play at full speed.

If you regularly use RED HDRx media, multiple high-end GPU cards are recommended for optimal decoding performance.

Introduction to Compositing

Using the Alpha Output

While DaVinci Resolve can use the alpha channel of imported media for compositing, the Alpha Output in the Node Editor is an optional output that you can turn on to create clip transparency using operations inside DaVinci Resolve to create composites against other clips on lower video tracks. There are many ways of using the Alpha Output, but this section will focus on three examples.

Using a Qualifier Key to Create Transparency

In this first example, the Alpha Output will be used to composite a green screen clip with a background plate.

In preparation for this composite, the background plate is on track V1 of the Timeline, and the green screen clip has been superimposed on track V2.
To create a chroma-key composite in the Color page:

1. Right-click anywhere within the gray area of the Node Editor and choose Add Alpha Output to add the Alpha Output at the right of the node graph.

   An Alpha Output appears underneath the Node Tree output at the right of the Node Editor.

2. You’ll want to use Node 1 to color correct the image to optimize it for keying. In this example, the foreground plate is log-encoded, so a LUT is added to Node 1 to normalize it.

3. Add a Serial node after Node 1 and connect its key output to the Alpha Output. This is a fast way to build this composite if you’re confident that the corrections you’ve made in Node 1 won’t adversely affect the key (or if you know they’ll improve it by expanding the contrast of a flat-contrast source clip).

   Alternately, you could create a second processing branch by adding a disconnected node (Node 2), connecting the Source node to its RGB input, and then connecting its key output to the Alpha Output you just added. Creating a second image processing branch from which to pull your key lets you key directly from the source (assuming the source is fit to key without adjustment), avoiding any problems that grading the first node could introduce to the key.

4. Use the Qualifier controls of Node 2 to key out the green background, and then turn on the Invert checkbox to create the proper composite. In this example, we’re using the 3D Qualifier mode to pull a high-quality key.
5 If there’s green spill in the composite (or blue in cases where you’re keying a bluescreen) you can turn on the Despill checkbox to eliminate it.

6 You can also use a Power Window to garbage matte out any elements you don’t want intruding into the shot, using the Tracker palette if necessary to make the window follow the motion of the foreground subject.

7 If necessary, you can add another node to the output of Node 2 to make whatever corrections are necessary to the background plate clip to make the composite blend more seamlessly. For example, with this additional node selected, you could right-click the background clip and choose “Shot Match to This Clip” to use the automatic shot matching in DaVinci Resolve to adjust the foreground to match the background.
Adding more color adjustments to a node added after the qualifier

With all this set up, you end up with a nice green screen composite that’s visible in both the Color and Edit pages.

The result, with a window garbage matte cropping out the equipment, ready for further refinement

**Using a Matte to Create Transparency**

If you’ve been provided with a separate Matte clip for defining clip transparency, you can use that Matte clip within the node tree of a superimposed clip to create a composite using the Alpha Output.

**To create a composite using an external matte:**

1. To associate an external matte with a clip, open the Media page, select the clip you want to add a matte to in the Media Pool, navigate to the matte file using the Library browser, and then right-click the matte file and choose Add as Matte. For more information on importing mattes, see Chapter 143, “Combining Keys and Using Mattes.”

2. Open the Color page and select the foreground clip in the Thumbnail timeline, then right-click Node 1 in the Node Editor and choose the matte you added from the Add Matte submenu.

   An EXT MATTE node appears underneath Node 1, with the first of its four key outputs connected to Node 1’s key input. (Working with external mattes is covered in more detail in a prior section of this chapter.)

3. Now, right-click anywhere within the node graph (other than on a node) and choose Add Alpha Output from the contextual menu.

   An Alpha output appears underneath the Node Tree output.

4. Drag a connection line from the second key output of the EXT MATTE node to the Alpha output.
Using an external matte in the grade and to the Alpha output

You should now see a successful composite, with the external matte creating a region of transparency in the foreground clip through which the background clip shows through.

Before and after the final composite, created by connecting an EXT MATTE node to the Alpha output in the node graph

Use an OFX Plug-in to Create Transparency

If you’ve installed an OFX plug-in capable of keying, you can right-click the node you’ve applied it to and choose Use OFX Alpha to route the key created by the plug-in out the key output of that node. When Use OFX Alpha is enabled, the HSL Qualifier and Window palette output is ignored, the only key that’s output is from the OFX plug-in.

Choosing Use OFX Alpha in the Node Editor

Once Use OFX Alpha is enabled, and you’ve created a key using your OFX plug-in of choice, you can right-click anywhere within the node graph (other than on a node) and choose Add Alpha Output from the contextual menu to make the Alpha output appear, and you can then connect the key output from the node with the OFX plug-in to the Alpha output to use it to create transparency.
Setting up a composite using an OFX plug-in

**NOTE:** When Use OFX Alpha is enabled for a node, you cannot use a window to create a garbage matte within that node as you would when keying with the HSL Qualifier. To create a garbage matte with which to exclude unwanted and unkeyable elements from the edges of the picture, you’ll need to combine the key from a window in another node with the key output by the OFX plug-in using a Key Mixer node.

Combining an OFX key with a window using a Key Mixer to add a Garbage matte

Compositing Entirely Within an OFX Plug-In

Certain OFX plug-ins that are capable of combining two image streams to create a composite can be used as of DaVinci Resolve version 11.1 by exposing a “second layer input” on the node to which that plug-in has been applied. This makes it possible to composite the image you’re grading with the RGB output from an EXT MATTE node.

Combining a clip with an EXT MATTE image using the second layer input of a node with an OFX plug-in applied to it
To create a composite using an OFX plug-in:

1 Open the Open FX panel, use the Library to find the OFX compositing plug-in that you want to use, and drag it onto the appropriate node to apply it. The above example shows the Boris Effects plug-in “BCC Composite,” which mathematically combines two image streams using one of a long list of blending modes.

2 Right-click the node with the Open FX plug-in applied to it, and choose Second Layer Input from the contextual menu. A second RGB input should appear on the left of the node, underneath the first.

3 Open the Media page, locate the clip you want to composite in the Library, and import it as an unassigned matte.

4 Open the Color page again, right-click the node with the Open FX plug-in applied to it, and choose Add Matte > Track Mattes > “name of matte imported in step 3” from the contextual menu.

5 By default, the EXT MATTE node that appears is connected via one of its key outputs. Delete the key connection, and drag a new connection line from the EXT MATTE node’s RGB output to the second RGB input of the node with the OpenFX plug-in.

6 At this point, the node tree is wired up to composite the clip with the EXT MATTE image, and you need only adjust the parameters of the Open FX plug-in to achieve the result you desire.
Chapter 145

Keyframing in the Color Page

The Color page has a dedicated Keyframe Editor, found at the right of the palette area, that you can use to animate grading changes from one frame to another. Because grading is a fundamentally different task than editing, the Color page Keyframe Editor operates somewhat differently from the Curve Editor in the Edit page.

Contents

- Introduction to Keyframing
- The Keyframe Editor Interface
- All/Color/Sizing
- Keyframing Methods
  - Dynamic Keyframes (Dynamics)
  - Static Keyframes (Marks)
  - Mixing and Converting Dynamic and Static Keyframes
- Keyframed Nodes Have a Badge
- Using Specific Keyframing Tracks
  - Corrector Keyframing Tracks
  - ResolveFX Keyframe Tracks
  - The Sizing Keyframing Tracks
  - The Ext Matte Node’s Freeform Isolation Track
- Automatic Keyframing
- Modifying Keyframes
  - Navigating Among Keyframes
  - Moving Keyframes
  - Changing Keyframe Values
  - Changing Dynamic Attributes
  - Deleting Keyframes
Introduction to Keyframing

Whether it’s referred to as keyframing, dynamics, or marks, DaVinci Resolve provides an interface for automatically interpolating color adjustment parameters in various ways from one setting to another. For example, if you have a clip with varying exposure settings, you can animate a series of contrast adjustments using Dynamic keyframes to make the changes in exposure less distracting.

![The Keyframe Editor with dynamic keyframes animating the parameters of Node 2](image1)

In another example, suppose you’re grading a documentary, and an archival clip that’s edited in the middle of the Timeline actually consists of six different shots from a program in the eighties. If you’re in a hurry, you can insert Static keyframes (marks) at the cut points of each of these shots, creating instant one-frame transitions between different adjustments made to that clip’s grade, which allows you to create unique adjustments for each shot within the clip.

![Round static keyframes added to all parameters, enabling individual adjustment of shots merged together within a single clip](image2)

In both cases, you use the Keyframe Editor to create a series of keyframes with which to change parameters from one value to another. In this section, you’ll learn how to work with the Keyframe Editor to set up these kinds of animated changes.

The Keyframe Editor Interface

The Keyframe Editor has all the controls necessary to create and modify keyframes for the currently selected clip. If necessary, you can even make it wider in a single screen layout by clicking its expand button (at the top right of the Keyframe Editor). If you have two computer displays, you can use the Color page’s Dual Screen layout which places the Keyframe Editor on a second screen and uses the entire width of the monitor, for even more room.
The Keyframe Editor consists of the following components:

- **Timeline Ruler**: Mirrors the record timecode of the currently selected clip; dragging within the Timeline Ruler moves the playhead, and a timecode display to the left shows the current frame.

- **Keyframe track header**: Each node in the current grade has a corresponding keyframe track, Sizing has its own keyframe track, and the track header contains controls you can use to manage the keyframing.

  - **Enable/Disable button**: A round white button lets you enable or disable that track’s corresponding node.

  - **Lock button**: Lets you prevent any changes from being made to that track’s corresponding node. Nodes that have been locked show a lock icon. You can also lock or unlock nodes by right-clicking a node in the Node Editor and choosing Lock Node from the contextual menu.

  - **Auto-Keyframe button**: Turn this button on to automatically create a Dynamic keyframe every time you adjust any parameter within that node.

  - **Track disclosure triangle**: Exposes individually keyframable groups of parameters underneath the main keyframe track.
– **Keyframe tracks:** To the right of the track header, the keyframe tracks are where you create and edit the keyframes that animate parameter changes. A topmost “master keyframe track” shows every keyframe applied on every keyframe track in the Keyframe Editor, even keyframes applied to a keyframing track hidden inside a track with a closed disclosure triangle.

– **Keyframes:** Each keyframe appears as a small diamond for a Dynamic keyframe or as a circle for a Static keyframe. Dynamic keyframes are associated with dissolves while Static keyframes (marks) act instantly. Grades are linked to the preceding keyframe, which may be a default one on the first frame of the master clip. Keyframes can be selected by clicking on them, or moved by dragging them to another position in the keyframe track.

– **FX track:** Resolve FX or OFX plug-ins that have been added to a grade as a standalone node have a separate track for creating animated effects. Every parameter of that track is keyframed via a single consolidated keyframe track. If you apply multiple plug-ins as multiple nodes, each has a separate FX track.

– **Sizing track:** The Pan, Tilt, Zoom, Rotate, and Convergence (in Stereo 3D projects) parameter have an entirely separate track for creating animated pan and scan adjustments.

– **Track selection drop-down:** A colored bar shows the currently selected scope of keyframing: all tracks at once, just the current correction node, or the Sizing settings, as defined by the Keyframe Timeline mode discussed in the next section.

Ordinarily, the Keyframe Editor takes up the rightmost bottom third of the Color page. However, you can make it wider to have more room to work if you have a scene requiring complex keyframing.

**To expand and collapse the Keyframe Editor:**

– Click the Expand/Collapse button at the top right corner of the Keyframe Editor. The Keyframe Editor widens or narrows accordingly.

**To zoom into and out of the keyframe tracks:**

– Use the Zoom slider to zoom into or out of the Keyframe Editor.

– Right-click any keyframe track and choose Maximum Zoom to zoom all the way in.

– Right-click any keyframe track and choose Reset Zoom to fit the entire clip into the available width of the Keyframe Editor.

## All/Color/Sizing

Perhaps the most important control for keyframing, the Keyframe Timeline mode, lets you switch the scope of what tracks get keyframed when you use the Start Dynamic or Add Static Keyframe commands, either from the keyboard or via the buttons of your control panel. This command alternates among three modes:

– **All:** The default mode. Adds keyframes to every track in the Keyframe Editor, keyframing every parameter in every node all at once, including the Sizing settings. In this mode, an orange bar appears highlighting the topmost “master keyframe track.”

– **Color:** Only adds keyframes to the node currently selected in the Node Editor. In this mode, a green bar appears highlighting the keyframe track corresponding to the node currently selected.

– **Sizing:** Only adds keyframes to the Sizing track, which is useful when you’re keyframing “pan and scan” style transforms. In this mode, a blue bar appears highlighting the Sizing track.

– **EXT MATTE:** Only appears if there’s an external matte node in the node tree. Lets you keyframe external matte-specific parameters in the Key palette.
Even though All is the default setting, it may be to your advantage to switch to the Color or Sizing keyframing modes to avoid creating a lot of unnecessary keyframes. Even though keyframing everything all at once is a fast way to work, the extra keyframes may slow you down when you later need to make adjustments to nodes that didn’t need to be keyframed in the first place.

**To change the keyframing mode, do one of the following:**
- Choose an option from the Keyframe mode drop-down at the top right of the Keyframe Editor.
- Choose an option from the Mark > Keyframe Timeline mode submenu.

**TIP:** This control has one other function. Choosing a mode also affects what is copied when you use the various grade management tools in DaVinci Resolve. For example, if you choose Color, then you can copy a clip’s color grade without copying its sizing. If you choose Sizing, then you can copy the sizing without copying the color grade. For more information, see “Copying Grades” in Chapter 139, “Grade Management.”

### Keyframing Methods

There are two different types of keyframes used by DaVinci Resolve to create automated changes. Each type of keyframe interpolates parameters differently.

#### Dynamic Keyframes (Dynamics)

Dynamic keyframes are the most conventional type of keyframe you’ll use, and are the type of keyframe used for creating animated changes from one state to another. For example, if you need a grade to become brighter over time to compensate for a change in lighting conditions, you’ll use Dynamic keyframes.

Nearly every parameter and control in the Color page can be keyframed, but it’s important to understand that the Interface controls do not animate to match whatever dynamically keyframed changes are taking place. Instead, visible Interface controls that correspond to keyframed changes will jump from their initial position at one keyframe to their final position when the playhead reaches the next keyframe.

This can be most confusing with Curves, which can be interpolated using Dynamic keyframes just like any other control or parameter. Just keep in mind that the actual settings are animating, even though the controls are not.

**To animate a node using Dynamic keyframes:**

1. Move the playhead in the Keyframe Editor’s Timeline ruler to the frame where you want to begin a change.
2. Do one of the following to place a Dynamic keyframe at that frame:
   - Choose Mark > Add Keyframe (Command-J).
   - Turn on the Auto Keyframe button for the track you want to animate in the Keyframe Editor.

   Dynamic keyframes are diamond-shaped.

3. If necessary, adjust your clip at this first position of your animated change. If you’re using Auto Keyframe, then you have to make an adjustment for a keyframe to be created.

4. Now, move the playhead to the frame that is at the second position of the animated change you’re making, and create another Dynamic keyframe if you’re creating keyframes manually, or make another adjustment if Auto Keyframe is on.
After you've created this second keyframe, make whatever adjustments are necessary to the clip to create the final look you need.

At this point, playing from the first keyframe to the second keyframe should show a smoothly animated change from the first adjustment to the second. When you're finished, make sure you turn Auto Keyframe off if it was enabled.

**Static Keyframes (Marks)**

Static keyframes, or marks, are keyframes that are used to create abrupt, one frame changes from one state to another. They're typically used to mark edit points separating one shot from another when multiple shots appear within a single clip. However, Static keyframes are also useful in any situation where you need a sudden change from one setting to another, such as when creating a lightning effect.

To automate a node using Static keyframes:

1. Find the frame at which you want the abrupt change to take place, and place a keyframe at that frame by doing one of the following:
   - Choose Mark > Make Static Keyframe (Command-\).
   - Static keyframes (marks) are round.

2. Move the playhead to any frame before the keyframe to make changes to the entire segment of the clip leading up to the keyframe, or move the playhead to any frame after the keyframe to make changes to the entire segment of the clip appearing after the keyframe. The playhead does not need to be on top of the keyframe, but if it is, you’ll be adjusting the second portion of the clip.

NOTE: If you’re using Static keyframes to automate grading changes between multiple shots appearing within a single clip, keep in mind that you can’t add nodes from one keyframe to the next as you would if you had split the clip in the Edit page.

**Mixing and Converting Dynamic and Static Keyframes**

Typically, if you’re creating multiple animated changes within a clip, you’ll want to use all Dynamic keyframes. Similarly, if you’re creating a series of abrupt changes, you’ll use all Static keyframes. However, you can mix Dynamic and Static keyframes together, so long as you keep in mind the following rules:

- **If you add a Dynamic keyframe to the right of a Static keyframe:** There will be no interpolation from the Static keyframe to the Dynamic keyframe. However, if you add a Static keyframe to the right of a Dynamic keyframe, there will be interpolation.
If you accidentally create the wrong kind of keyframe, it’s easy to convert it into the type of keyframe you need.

**To change one kind of keyframe into another:**

1. Click the keyframe you want to convert to select it.
2. Right-click the selected keyframe, and choose either Change to Dynamic Keyframe or Change to Static Keyframe.

**Try Creating Keyframed Changes in a Separate Node**

One tip to keep in mind is that you don’t have to create keyframed changes within the same nodes you’re using to create other adjustments. If you want to create some automated changes without altering the nodes you’ve already adjusted, you can simply create a new node in which to make your keyframed changes. That way, if you don’t like the result, or you somehow find yourself hopelessly tangled up in a needlessly complicated set of keyframes, it’s easy to reset either just the keyframes or the entire node without affecting the rest of your grade.

**Keyframed Nodes Have a Badge**

Nodes with keyframed parameters display a keyframe badge in the Node Editor, to make them easy to find. Note that keyframe badges won’t appear when you simply add a keyframe but only once there’s an actual keyframed adjustment being made.

**Using Specific Keyframing Tracks**

If you’re simply using the Color mode of the All/Color/Sizing command to do keyframing, then you’ll be adding keyframes to every parameter of the currently selected node whenever you apply a single keyframe. However, often that’s overkill in situations where you only need to keyframe a single setting or group of settings.

For example, you may find that you need to keyframe a color adjustment in order to change the color temperature and brightness when the camera pans across a window, but you don’t want to keyframe
the Windows palette controls because you want to adjust them independently. This can be done by opening a Corrector track to expose the keyframing tracks within.

Keyframing tracks let you keyframe different sets of similarly functioning parameters separately from one another. For example, there’s one keyframing track for all the color adjustment parameters, and another keyframing track governing the parameters found within the Qualifier palette.

**To reveal a node’s keyframing tracks:**

Click the disclosure triangle next to the number of the node you’re keyframing.

**To keyframe an individual keyframing track manually:**

1. Make whatever adjustments you need to the currently selected node, and click its disclosure triangle to reveal its keyframing tracks.

2. Move the playhead in the Keyframe Editor to where you want to add the first keyframe, then right-click within the keyframing track you want to animate, and choose Add Static Keyframe or Add Dynamic Keyframe (this example shows a Dynamic keyframe).

   A keyframe appears at the position of the playhead in that keyframing track.

3. Move the playhead in the Keyframe Editor to where you want to add the next keyframe, then right-click within the keyframing track and again choose either Add Static Keyframe or Add Dynamic Keyframe (this example shows a Dynamic keyframe).

Now, you can make whatever changes you need to the controls governed by the keyframing track you keyframed, in order to create the necessary animated effect.

**TIP:** You can also animate individual keyframing tracks using automatic keyframing, explained in more detail later in this chapter.
Corrector Keyframing Tracks

All of the parameters governing the adjustment of color and contrast controls, as well as various effects, Power Windows, and other adjustments are sorted into various sub-tracks within the Corrector track.

- **Linear Win**: Controls parameters corresponding to the Linear window.
- **Circ Win**: Controls parameters corresponding to the Circular window.
- **Polygon Win**: Controls parameters corresponding to the Polygon window.
- **PowerCurve**: Controls parameters corresponding to the PowerCurve window.
- **Gradient Win**: Controls parameters corresponding to the Gradient window.
- **Color Corrector**: Controls all parameters found in the Camera Raw, Color Wheels, Primary Controls, RGB Mixer, and Curves palettes.
- **Qualifier**: Controls all parameters in the Qualifier palette.
- **Defocus**: Controls all parameters in the Blur and Key palettes.
- **NR**: Controls the Spatial and Temporal Noise Reduction and Motion Blur parameters found in the Motion Effects palette.
- **Open FX**: Controls all parameters of whichever OFX plug-in is applied to the current node.
- **Node Format**: Controls all parameters of the node sizing mode of the Sizing palette for the current node.

ResolveFX Keyframe Tracks

The Color Page Keyframe Editor supports viewing and editing keyframes for ResolveFX and OpenFX plug-ins in the Color page in one of two ways:

- Plug-ins that have been added to a Corrector node appear within the hierarchical list of keyframe tracks that appear within that node’s top-level keyframe track.

  ![The keyframe track of a Resolve FX plug-in added to a Corrector node](image)

- Plug-ins that have been added as standalone nodes appear within a new FX track of the Keyframe Editor. Each plug-in that’s added as a separate node has a separate FX track.

  ![The keyframe track of a Resolve FX plug-in added as a standalone node](image)
The Sizing Keyframing Tracks
The Sizing keyframing tracks govern sizing transforms and stereoscopic adjustments separately from the color controls.

- **Input Sizing**: Controls the Input Sizing parameters found within the Sizing palette.
- **Convergence**: Controls the Convergence parameter in the Stereo 3D palette.
- **Float Window**: Controls the Left, Right, Top, and Bottom Position/Rotate/Softness Floating Windows parameters.
- **Auto Align**: Controls the Pitch and Yaw parameters in the Stereo 3D palette.

**TIP**: Output Sizing can only be keyframed when you choose Timeline mode in the Node Editor.

The Ext Matte Node’s Freeform Isolation Track
If your node tree has an External Matte, the EXT MATTE node exposes a Freeform Isolation track in the Keyframe Editor. This is useful for time offsets or Sizing repositioning of the Ext Matte image.

Automatic Keyframing
Every track in the Keyframe Editor has an Auto-Keyframing button that can be turned on or off. When auto-keyframing is enabled for a particular track, every change made to a parameter or control associated with that keyframe track automatically generates a keyframe. There are two ways you can use this:

- Used with a keyframing track, auto-keyframing makes it simple to set up animated changes to specific adjustments within a node. This is a lot easier than manually placing keyframes one by one.
- On the other hand, turning on auto-keyframing for the Corrector track correspondingly enables auto-keyframing for every keyframing track belonging to that node. In this case, keyframes will automatically be placed on whatever keyframing track corresponds to the parameters or controls you adjust.

When auto-keyframing is disabled, changes you make alter existing keyframes. How this alteration works depends on the location of the playhead, and the type of keyframes in the Keyframe Editor. For more information, see the next section.
Modifying Keyframes

Once you’ve started adding keyframes to animate changes to a grade, there are a variety of methods available to navigate and edit these keyframes to further customize these effects. This section covers the different ways you can navigate among, alter, and remove keyframes.

Navigating Among Keyframes

For many operations, it’s necessary to move the playhead directly on top of the keyframe you want to modify. While you can always use the transport controls or pointer to move the playhead, there are also commands for jumping to a specific keyframe.

To move the playhead among a series of keyframes:
– Choose Playback > Next > Keyframe (the right bracket key) or Playback > Previous > Keyframe (the left bracket key).

Moving Keyframes

If you need to change the timing of a series of keyframes, you can move the position of any keyframe, along with whatever values that keyframe contains.

To move a single keyframe using the onscreen interface:
– Use the pointer to drag any keyframe to another location.
– Drag keyframes in a top-level Corrector or Sizing track to simultaneously move all other keyframes on the same frame within that corrector.

To move multiple keyframes at the same time:
1 If necessary, open the keyframe track with the keyframes you want to move.
2 Drag a bounding box around the keyframes you want to move. Selected keyframes appear highlighted in red.
3 Drag any of the selected keyframes to move them to the left or right.

Changing Keyframe Values

Unlike many other applications, DaVinci Resolve lets you alter keyframe values when the playhead isn’t directly on an existing keyframe. How this works depends on the location of the playhead relative to the keyframes that are in the Keyframe Editor, and what kind of keyframes you’re editing.

– If the playhead is to the left or on the first Dynamic keyframe: The Dynamic keyframe at or to the right of the playhead updates with the new adjusted values.
– If the playhead is to the left or on the last Dynamic keyframe: The Dynamic keyframe at or to the left of the playhead updates with the new adjusted values.
– If the playhead is between two Dynamic keyframes: The Dynamic keyframe to the left of the playhead updates with the new adjusted values, but the Dynamic keyframe to the right is unaffected.
– If the playhead is between two Static keyframes (marks): Adjustments made between two Static keyframes always affect the keyframe to the left of the playhead. The entire segment of the clip between that keyframe and the next is affected equally.
Changing Dynamic Attributes

By default, the transition from one Dynamic keyframe to the next is linear. However, if you need to alter the acceleration of value interpolation from one Dynamic keyframe to the next, then you can change that keyframe’s dynamic attributes.

To change a keyframe’s dynamic attributes:

1. Click to select a keyframe in the Keyframe Editor.
2. Right-click the selected keyframe, and choose Change Dynamic Attributes.
3. When the Dynamic Attributes window appears, do one or both of the following:
   - Choose a new outgoing acceleration curve using the Start slider, affecting the interpolation occurring to the right of that keyframe.
   - Choose a new incoming acceleration curve using the End slider, affecting the interpolation occurring to the left of that keyframe.

As you choose different acceleration curves, the display to the right shows the resulting curve graph.

4. When you’re happy with the curve, click OK.

By using different Start and End values, you can make animated adjustments “ease in” or “ease out” of a particular keyframe, to create a more gradual or abrupt transition.

**TIP:** The default dynamic profile start and end of each new keyframe can be set via the Dynamics Profile values in the General Options panel of the Project Settings.
Deleting Keyframes

You have the option to delete individual keyframes, or to delete all the keyframes within a particular grade at once.

To delete individual keyframes, do one of the following:

– Move the playhead on top of the keyframe you want to delete, then choose Mark > Delete Keyframe (Option-J). Every keyframe at the position of the playhead is deleted.

– Using the pointer, click a keyframe in the Keyframe Editor to select it, then right-click that keyframe and choose Delete Selected Keyframe. Only the selected keyframe is deleted.

To delete every keyframe for the current clip:

– Choose Mark > Delete All Keyframes.

Copying Keyframes

It’s possible to copy a set of keyframes from one node to another, either within the current grade, or in another clip entirely. It’s also possible to copy an entire grade with keyframes from one clip to another.

To copy a set of keyframes from one node to another:

1. Select a node to copy keyframes from, and choose Edit > Copy (Command-C).
2. Do one of the following:
   – To copy all keyframes, select another node to paste keyframes and other adjustments to, and choose Edit > Paste (Command-V).
   – If you want to just copy only the keyframe information from a specific keyframe track, choose Edit > Paste Attributes (Option-V), then click the “Copy Keyframes and Align Using” checkbox, and select the appropriate parameters to copy.

**TIP:** This procedure also works for tracking data that you want to copy from one node to another, either in the current clip, or another clip altogether.

To copy an entire grade with keyframes from one clip to another:

1. Click the thumbnail of the clip you want to copy to in the Thumbnail timeline.
2. Right-click the thumbnail of the clip you want to copy from, and choose Apply Grade from the contextual menu.

**NOTE:** When copying a grade with keyframes from one clip to another, the keyframes will automatically be placed at matching frames that correspond to the source timecode of the originating clip. This makes it easy to copy a grade with keyframes to the same clip elsewhere in the Timeline, but it may not provide the desired results if you’re applying a grade with keyframes from one clip to a completely different one.
Keyframes and Saved Stills

If you save a still from a clip using keyframes within the grade, by default keyframes are not saved. However, the still and grade that are saved reflect whatever parameter values are contained by the next keyframe to the left of the position of the playhead. For example, if a clip has a dynamically keyframed transition from a saturation of 50 to a saturation of 0, and you place the playhead right in the middle of both keyframes when you save a still, the grade and still that are saved have a saturation of 50.

However, if you right-click the background of the Gallery, choose one of the options within the “Apply Grades Using” submenu, and choose the appropriate “Keyframes Aligning…” options, then grades saved within a still are saved with the keyframes, which reference the source timecode, or start frame of the original clips. This means that if you apply a saved grade with keyframes to a clip, the keyframes will automatically be placed at matching frames that correspond to the source timecode or start frame of the original clip. This makes it easy to copy a grade with keyframes to the same clip elsewhere in the Timeline, but it may not provide the desired results if you’re applying a grade with keyframes from one clip to a completely different one.

Adding EDL Marks

Just as clip grades are separate from the timeline grade that can be applied to the entire Timeline, so clip keyframes are separate from timeline keyframes. Keyframes you apply to the timeline grade work exactly the same as clip keyframes. However, there is one extra option you have when keyframing the timeline grade.

If you find yourself wanting to adjust a timeline grade individually to take into account variations from one clip to the next, you can use the Add EDL Marks on Tracks command to add a Static keyframe (mark) to the Keyframe Editor at the position of every edit point in the entire Timeline.

To add EDL marks:

1. Choose Timeline from the Node Editor’s mode drop-down menu.
2. If you want to keyframe a grade, then create whatever grade you need to apply to the entire Timeline. If you want to keyframe Sizing settings, you don’t need to do anything else.
3. Right-click the Corrector track or the Sizing track in the Keyframe Editor, and choose Add EDL Marks on Tracks.

Marks appear at the frame of every edit point in the Timeline. You may want to widen the Keyframe Editor to make it easier to work with all these keyframes.

After you’ve added EDL marks, you can delete them if you decide you don’t want them any more.

To delete EDL marks:

– Right-click the Corrector track in the Keyframe Editor, and choose Delete EDL Marks on Tracks.

If you’ve added your own keyframes in addition to the EDL marks, then the Delete EDL Marks on Tracks command only eliminates the EDL marks. Your custom marks are left alone.
Chapter 146

Copying and Importing Grades Using ColorTrace

ColorTrace is a key feature of DaVinci Resolve, which lets you copy grades quickly and easily from the clips of one timeline to those within another, based on the source timecode of each clip (or using clip names when in Automatic mode). You can even use ColorTrace to copy grades between timelines within the same project, and ColorTrace one stereo timeline to another.

Contents

Copying Grades Using ColorTrace 2870
Using ColorTrace in Automatic Mode 2871
Using ColorTrace in Manual Mode 2874
Importing CDL Data Using ColorTrace 2876
Using CDL Adjustments 2877
Calculating CDL Functions 2877
Copying Grades Using ColorTrace

ColorTrace copies whichever version of a clip's grade was applied in the Source timeline you're copying from, either local or remote, depending on which grades each clip in the Source timeline is set to use. Furthermore, ColorTrace copies Group Pre-Clip and Group Post-Clip grades, as well as Fusion compositions. These improvements make this an extremely reliable tool for copying grades from one timeline to another in a wide variety of situations.

To use ColorTrace:

1. Open the Edit page and select the Timeline you want to use ColorTrace with from the Media Pool, then open it and choose Timelines > ColorTrace > ColorTrace From Timeline.

2. Using the Project List browser, select the specific Timeline you want to copy grades from. You'll need to click the disclosure triangle to the left of the database, user name, and project that contains that Timeline in order to select it.

**Choosing ColorTrace for a selected Timeline**

The ColorTrace Setup window appears, which shows every database, user, project, and timeline within a single hierarchical list.

**ColorTrace project and Timeline selection window**

Chapter 146  Copying and Importing Grades Using ColorTrace  2870
(Optional) If you’re using ColorTrace with a project that has numerous VFX clips in a workflow where all VFX clips have specific reel names that identify them, you can enter these names (with asterisks (*) used as wildcards that indicate text in each reel name that can vary) in the “Effects Shot Definitions” field.

This speeds automatic ColorTrace operations by enabling DaVinci Resolve to use fuzzy string matching when a clip’s reel number qualifies it as a VFX shot so that the best match is displayed first on the list. You can enter multiple VFX reel names with wildcards, one per line, for simultaneous string matching. You can use whatever reel name text makes sense for your workflow, some examples of VFX reel names are as follows:

* _COMP_*
VFX*
EFFECTS*

Click Continue.

The ColorTrace window appears with two tabs that let you choose how to work.

Choose which mode to work in by clicking the Automatic or Manual tab:

– In Automatic mode, ColorTrace automatically searches for matching clips between the selected Timeline and the current Timeline. Each clip is color coded depending on the correspondence that’s been identified.

– In Manual mode, you copy grades yourself, using the Copy and Paste procedures, or by dragging and dropping using your mouse.

The ColorTrace window is complex; details about the operation of each mode are covered separately in the following sections.

When you’re finished using ColorTrace, click Close.

Using ColorTrace in Automatic Mode

In Automatic mode, ColorTrace automatically finds the correspondences between clips in the selected Timeline that you want to copy grades from (the Source timeline), and those in the current Timeline that you want to copy grades to (the Target timeline).

Each clip in the Target Timeline Thumbnail timeline is outlined with a color that indicates its status.

– **Red:** No match was found at all. Generally true for clips in the current Timeline that weren’t used in the Timeline you’re ColorTrace matching to.

– **Blue:** Due to overlapping timecode and reel names, multiple correspondences have been found (similar to a reel conflict), and you must select the correct one for each clip. This often happens with VFX and motion graphics clips that you’ve imported with timecode starting at 00:00:00:00.

– **Green:** A match has been found.
In Automatic mode the correspondence between each clip in the Source timeline and each clip in the Target timeline should be automatically made. However, overlapping timecode and reel names can cause problems. The other controls in the ColorTrace window help you deal with the subset of clips that can’t be automatically matched, or are matched in error. These controls are:

- **Matching Source Clips list:** Shows a scrollable collection of thumbnails that might correspond to the selected clip in the Target timeline.

- **Target Timeline:** Shows each clip in the Timeline you want to copy grades to, color coded according to how good a match it is.

- **Clip Info pane:** Displays two columns of properties for the source clip and the target clips that you’ve selected. These properties include the reel, source timecode, record timecode, clip name, project names, and timeline names of each clip, for easy comparison.

- **Attributes and options checkboxes:** A series of checkboxes lets you specify which clip attributes are copied as part of the ColorTrace operation.

  - **Color:** Enables the copying of grades.
  
  - **Preserve Num Nodes:** When copying grades, lets you prevent the first X nodes of the target clip grades from being overwritten by the first X nodes of the source clip grades.
  
  - **Sizing:** Enables the copying of Edit sizing attributes.
  
  - **Input Sizing:** Enables the copying of Input Sizing attributes.
  
  - **Convergence:** Enables the copying of Convergence for Stereo 3D projects.
  
  - **Floating Windows:** Enables the copying of Floating Windows for Stereo 3D projects.
  
  - **Auto Align:** Enables the copying of Auto Align settings for Stereo 3D projects.
  
  - **All Versions:** Copies all versions, rather than just the current version, from the source to the target clips. The currently selected version of each source clip is always correctly copied.

  - **Version Camera Raw Settings:** Enables the copying of versioned Raw settings, rather than just the current Raw setting.

  - **Track Marks:** Enables the copying of keyframes.
– **Flags and Markers**: Enables copying of all flags and markers.
– **Hide Matching Clips**: Hides all clips which have been successfully matched, and only show the clips with multiple or no matches. This lets you focus on the subset of problem clips within a potentially long timeline.
– **Ignore Reel Names**: If you believe the reel names are in error, you can turn this checkbox on to ignore them, matching all source and target clips by timecode alone.
– **Copy Grades**: Copies the matched source grades to each green and purple target clip.
– **Copy Grades & Exit**: Once you’ve finished making all the grade matches you can, click this button to copy the matched source grades to each green and purple target clip, and close the ColorTrace window.

Here’s how to use these controls to sort out which source clips to copy from for each blue and red target clip in the Target timeline.

**To manually choose which source grades should be copied to which target clips:**

1. Click any blue clip thumbnail in the Target timeline.

![Screen shot of ColorTrace interface](image)

Revealing a number of different possible correspondences in the Matching Source Clips Timeline

A collection of clips with overlapping timecode and reel names appears. If you want to ignore the reel names because you believe they might be in error, turn on the Ignore Reel Names checkbox.

2. If a comparison of the Source and Target thumbnails doesn’t make the choice obvious, then click any of the clips in the Matching Source Clips timeline to view its metadata for comparison in the source/target columns below.

<table>
<thead>
<tr>
<th>Property</th>
<th>Source</th>
<th>Target</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reel</td>
<td>SRC 00:00:00.00 00:03:05</td>
<td>SRC 00:00:00 00:03:18</td>
</tr>
<tr>
<td>REC</td>
<td>REC 01:01:27:11 01:30:30:16</td>
<td>REC 01:01:27:11 01:30:31:05</td>
</tr>
<tr>
<td>Name</td>
<td>Pool Shark Title.mov</td>
<td>Pool Shark Title.mov</td>
</tr>
<tr>
<td>Project</td>
<td>Pool Shark</td>
<td>Pool Shark Editing Refinement</td>
</tr>
<tr>
<td>Timeline</td>
<td>Pool Shark (Trimming)</td>
<td>Pool Shark (Trimming)</td>
</tr>
</tbody>
</table>

Source and Target clip metadata for comparison

3. Once you’ve decided on a clip correspondence, double-click the Matching Source Clip thumbnail you want to copy from. If no clip in the Matching Source Clip pane is a good match, double-click the “Set As New Shot” box.
The Source and Target thumbnails both turn purple, to show that you’ve created a correspondence.

Continue working your way through every thumbnail with Blue and Red Xs until you’ve found matches for every clip in the Timeline for which it’s possible.

4 When you’re finished, click Copy Grades & Exit.

**Using ColorTrace in Manual Mode**

Manual mode is ideal for situations where you want to copy grades between programs with clips that have no timecode or reel name correspondence at all. The Manual ColorTrace interface is designed to let you move through two different timelines, either a clip at a time, or in matching multiples of clips, copying grades from the Source timeline to the Target timeline.

For example, if you’re trying to copy grades from a timeline that was conformed from individual media files, to another timeline that was conformed from a flattened master media file, you can use the ColorTrace Manual mode to accomplish this.

The manual interface consists of two sets of controls that correspond to the Source timeline (labeled “Timeline to copy from”), and the Target timeline (labeled “Timeline to paste to”). The general idea is that you move through both sets of timelines one clip at a time, or in matching multiples of clips at a time, and copy grades from the “Copy from” timeline to the “Paste to” timeline.
Manual mode has the following controls:

- **Source timeline:** Shows all clips in the Source timeline you selected; the clips you’re copying grades from. Click any one clip thumbnail to select it, or click a thumbnail, and then Shift-click another thumbnail to select a contiguous range of clips. You cannot select a noncontiguous range of clips.

- **Copy Range controls:** Two fields show the range of clips in the current selection that you’ll be copying from, referred to by their numeric position in the Source timeline. You can change the range numerically by either entering new numbers in the fields, or by using the up/down arrow buttons to alter the value by one. The First button automatically adds all clips from the first one in the Timeline into the current selection. The Last button automatically adds every clip going to the last one in the Timeline to the current selection.

- **Target timeline:** Shows all clips in the Target timeline you selected; the clips you’re pasting grades to. Selecting clips works identically as with the Source timeline.

- **Paste Range controls:** Two fields show the range of clips in the current selection that you’ll be pasting to, referred to by their numeric position in the Source timeline. All controls work identically to the Copy Range controls.

- **Attributes and options checkboxes:** Turn off the checkboxes of any clip characteristics that you don’t want to copy as part of the ColorTrace operation. A more complete description of these options appears in the section on the Automatic ColorTrace mode.

- **Paste button:** Once you’ve selected one or more source clips and a matching number of target clips, clicking Paste copies the grades, PTZR settings, and marks (depending on the corresponding checkboxes).

- **Undo Last:** Lets you undo the most recent paste action.

- **Undo All:** Lets you undo all paste actions in Manual mode.

- **Done:** Finishes the operation and closes the ColorTrace window.

If you’re cherry picking individual grades from one timeline to paste into shots in another, you can copy grades one at a time.

**To copy one source grade to one target clip:**

- Click a thumbnail in the Source timeline (on top) to copy from, then click a thumbnail in the Target timeline (on the bottom), and click Paste.

You can also simultaneously copy the grades of entire scenes of clips from one timeline to another. For example, if you’re copying grades from an originally graded timeline to a re-edited version of the same program, you can copy every grade from a 10-clip scene in the Source timeline to the same 10 clips in the Target timeline which have been pushed back later in the Timeline.

**To copy a group of source grades to a group of target clips:**

1. Choose a continuous range of source clips by doing one of the following:
   - Click the first clip in the range, and then Shift-click the last clip in the range.
   - Enter the clip number of the first clip in the left “Copy Range” field, and then enter the clip number of the last clip in the right field.
   - Click a clip, and then click First to select every clip from that one to the first clip in the Timeline.
   - Click a clip, and then click Last to select every clip from that one to the last clip in the Timeline.

2. Choose a continuous range of Target clips by using the same procedures as in the previous step, but using the “Paste Range” controls.
IMPORTANT

You must select the same number of target clips as you did source clips for the Paste button to become enabled.

When you've made your selections, click Paste.

The grade settings from the source clips are pasted to the destination clips, in order. In other words, if you copy from clips 5 through 9 to clips 11 through 15, then grade 5 is copied to shot 11, grade 6 is copied to shot 12, grade 7 is copied to shot 13, and so on.

Importing CDL Data Using ColorTrace

The ColorTrace CDL command lets you import ASC CDL file formats from other applications into DaVinci Resolve. DaVinci Resolve also has the ability to read DRX filenames from CDL files, allowing a CDL to load exported DaVinci Resolve grades.

There are three supported file formats:
- **CMX EDL**: An EDL with comments referring to CCC/CDL XML files, or even Slope, Offset, and Power (SOP) data within the comment area.
- **CCC and CDL XML**: A file format that contains various color correction looks, and even references.

**To import CDL data into DaVinci Resolve:**

1. If you're importing CCC/CDL XML correction looks:
   - Open the Gallery page, right-click anywhere within the Stills tab, and choose Import from the contextual menu.
   - When the Import Stills dialog appears, open the CDL/CCC files. When these are finished importing into the Gallery, an ASC logo will appear along with them.
2. Open the Edit page and select the Timeline you want to use ColorTrace with in the Timeline list.
3. Right-click anywhere within the Timeline, and choose ColorTrace from CDL.
4. Select an EDL using the Select EDL dialog, and click Open.
5. Select its corresponding CDL and CCC files using the Select CDL Files dialog. If there are no CDL or CCC files (which is the case if there are inline SOP comments within the EDL), you should click Cancel.
6. Using the ColorTrace With CDL window, copy the source grades from the CMX EDL/CCC & CDL XML files to the Target timeline.

At this point, the ColorTrace window works identically as previously described.
For formatting reference, here are some examples of CMX, CCC, and CDL files.

Example CMX EDL File

```
TITLE: Final EDL FCM: NON-DROP FRAME 010 001 V C 01:19:28:16 01:19:28:16
01:00:41:18 01:00:42:18 *ASC_CC_XML test_cc.102 011 001 V C 00:00:00:00
01:19:28:16 01:00:42:18 01:00:43:18 *ASC_SOP (0.9 1.2 0.5)(0.4 -0.5 0.6)(1.0 0.8
1.5)
```

Example CCC File

```
<ColorCorrectionCollection xmlns="urn:ASC:CDL:v0.5" >
<InputDescription> test corrections for ref_input_image.1920 </InputDescription> <ViewingDescription>
for mathematical analysis only </ViewingDescription> <ColorCorrection id="test_cc.100"> <SOPNode>
<Description> for ref_output_image.0100 </Description> <Slope> 1.0 1.0 1.0 </Slope> <Offset> 0.0 0.0 0.0 </Offset> <Power> 1.0 1.0 1.0 </Power> </SOPNode> </ColorCorrection>
<ColorCorrection id="test_cc.101"> <SOPNode>
<Description> for ref_output_image.0101 </Description> <Slope> 1.0 1.5 0.6 </Slope> <Offset> 0.0 -0.1 0.01 </Offset> <Power> 1.0 1.5 0.5 </Power> </SOPNode> </ColorCorrection>
</ColorCorrectionCollection>
```

Example CDL File

```
<ColorDecisionList xmlns="urn:ASC:CDL:v0.5"> 
<InputDescription> GeneralProducts M1 std thru GP M1 LUT4 </InputDescription> <ViewingDescription> GP P1, DCI P3, Pathe color emul </ViewingDescription> <ColorDecision> 
<MediaRef ref="/some/Project/frame%250900-0954%5B.dpx"/> 
<ColorCorrection id="cc03340"> 
<SOPNode> <Description>change +1 red, contrast boost</Description> 
<Slope>1.2 1.3 1.4</Slope> <Offset>0.3 0.0 0.0</Offset> <Power>1.0 1.0 1.0</Power> 
</SOPNode> </ColorCorrection>
</ColorDecision> </ColorDecisionList>
```

Using CDL Adjustments

Once you’ve imported a CDL (Color Decision List), then the CDL adjustment for each clip is made available to you via a contextual menu command in the Thumbnail timeline of the Color page.

Calculating CDL Functions

To turn the SOP values into a primary correction, the following math is used by DaVinci Resolve:

```
Output = (Input * Slope + Offset)^Power
```

Output refers to the final grade. Input is the value of each pixel within each color channel (on a scale from 0–1). The detent value for Slope is 1. The detent value for Offset is 0. The detent value for Power is 1.
Lookup Tables, also known as LUTs, are one of the most ubiquitous means of creating, exchanging, and applying image processing operations there is for purposes of color management, display calibration, look management, and general-purpose processing of image color and contrast. DaVinci Resolve has robust support for LUTs throughout its image processing pipeline.

Contents

What is a LUT? 2879
Supported LUT Formats 2880
LUTs and ACES 2881
Adding Lookup Tables of Your Own 2881
Custom LUT Paths 2881
LUT Paths for the macOS App Store Version of DaVinci Resolve 2882
LUT Controls in the Project Settings 2882
Applying LUTs to Source Clips 2882
Using the Color Page LUT Browser 2882
Applying a LUT Within a Node 2884
LUTs Are the Last Operation Within a Node 2885
Favorite LUTs Submenu in Node Editor 2885
Exporting LUTs 2885
What is a LUT?

LUTs are simply files, similar to plug-ins but far more focused and with no user interface, that specify image processing operations. These operations are accomplished in a variety of ways. The traditional approach is to use a 1D table or 3D “cube” of pre-calculated values to perform an image color transform. However, newer LUT formats including CLF and DCTL let you use mathematical scripts to process an image.

Whatever type of LUT you use, these files can be loaded into DaVinci Resolve and applied at different points of the image processing pipeline to apply image processing operations for different purposes. There are several well-known uses of LUTs, but the important thing you should take away is that LUTs are simply color transform operations that can be used for many things, and there’s no single use of a LUT that’s more or less important than any other.

Here are some frequent uses for LUTs:

– While optionally superseded by Resolve Color Management (RCM), lookup tables (LUTs) have been frequently used to create a starting point adjustment for media acquired with some logarithmic encoding. DPX log film scans, digital media using the ARRI ALEXA’s Log-C encoding, Sony’s S-Log exposure setting, or RED R3D media that is debayered using the REDFilmLog setting are all examples of media using a logarithmic exposure curve, designed to protect as much detail in the highlights and shadows of a digitally encoded image as possible. While log-encoded media retains a lot of image data, the picture is initially flat and unsuitable for use without grading. The exposure and color must be adjusted to “normalize” the media, making it look closer to the way it’s supposed to, in order to start grading. While you can do this manually, it’s usually faster to use a LUT that’s tailored to your type of media and the exposures you’re using. Alternately, you can also use Resolve Color Management to accomplish this.

– LUTs are commonly used in onset workflows where dailies for different scenes are managed with corresponding LUTs. These LUTs were used to monitor the media as it was being recorded to define a baseline reference for how each scene is meant to look, at least so far as field monitoring is concerned. In more advanced workflows, LUTs are used as a baseline look, defined prior to the shoot and used during the shoot, that then defines the creative starting point for different scenes once grading begins after the shoot.

– LUTs are frequently used as a stylistic component of a grade, or “look” that gives users a quick start when desiring some manner of creative adjustment. Over the years, companies and individuals have created an ecosystem of such looks that are disseminated and sold in various LUT formats supported by DaVinci Resolve.

In all of these instances, LUTs are simply image processing adjustments that are applied to affect the color and contrast of a clip, in much the same way as you’d make adjustments using any of the contrast or color controls in the Color page.
Supported LUT Formats

DaVinci Resolve uses both 1D and 3D LUTs, and supports LUTs in a variety of formats.

- **.cube**: DaVinci Resolve uses both 1D and 3D LUTs in the .cube format. 3D LUTs can be exported as 17x17x17, 33x33x33, or 65x65x65 cubes with 32-bit floating point processing. DaVinci Resolve can also read and use Shaper LUTs in the .cube format, but these must also be created outside of DaVinci Resolve. You should note that while 17-point LUTs are not recommended to use for grading, they are useful when exporting LUTs for on-set monitoring, to accommodate different display, calibration, and signal conversion devices.

- **Panasonic VLUT format**: DaVinci Resolve can both read and generate this LUT format, designed for use in the Panasonic VariCam camera ecosystem.

- **Video Range LUTs**: Beginning with DaVinci Resolve 17, support was added for importing LUTs that include additional metadata specifying them as processing image data in Video Range, rather than Full Range. More information about how to format LUTs as Video Range is included in the Developer Documentation available from the Help menu. Being able to specify whether a LUT is meant to be Video or Full Range allows LUT processing to automatically accommodate DaVinci Resolve’s data range setting pipeline for clip attributes, project settings, and output settings.

- **CLF (common LUT format)**: CLFs use an XML format that is capable of encompassing a limited number of mathematical transforms in addition to traditional lookup-tables to do image processing. Promoted by the academy as the ideal LUT format for use with ACES, LMTs for ACES are recommended to be in the CLF format due to its increased precision and flexibility.

- **DCTL**: DCTL files are actually color transformation scripts that DaVinci Resolve sees and applies just like any other LUT. Unlike other LUTs, which are 1D or 3D lookup tables of values that approximate image transformations using interpolation, DCTL files are actually comprised of computer code that directly transforms images using combinations of math functions that you devise. Additionally, DCTL files run natively on the GPU of your workstation, so they can be fast. For more information on DCTL, see Chapter 191, “Creating DCTL LUTs.”

What’s the Difference Between a LUT and a Shaper LUT?

DaVinci Resolve is capable of importing and using LUTs within its 32-bit floating point image processing pipeline. The .cube format can be used as either a simple 33x33x33 3D LUT, or as a shaper LUT, which is actually a method of using two LUTs, a 1D LUT and a 3D LUT together, that addresses signal processing issues that 3D LUTs alone can’t handle.

For processor efficiency, 3D LUTs are designed with reasonable lower and upper limits for the data they will handle. It’s well known that when a 3D LUT is fed values that are outside of the range that LUT is designed to handle, the out-of-range data will be clipped. Since many LUTs are designed with digital cinema workflows in mind, the practical result is that feeding a video signal with super-white in it to a 3D LUT that’s designed for full-range data (0–1) will clip the super-white part of the signal.

Shaper LUTs handle this issue by first using a 1D LUT to process video signals with out-of-range data, fitting the signal into a range that the 3D LUT won’t clamp. The output of the 3D LUT includes the reverse transformation, to effectively zero out the 1D LUTs transform, while retaining whatever processing the 3D LUT was meant to apply.

Shaper LUTs are also useful for dealing with extremely large data sets, such as OpenEXR files that can theoretically handle an image data range of –infinity to +infinity. Using a Shaper LUT, you can remap the incoming data to fit more precision in the 0–1 range, leaving less important data outside the range.
LUTs and ACES

The academy that promotes the correct use of ACES strongly recommends that LUTs be processed in the ACES color space. For this reason, two project settings let you choose how this will be done:

- **ACEScc AP1 Timeline Space**: This setting works for either the ACEScc or ACEScct Color Science settings depending on what you've selected in the Color Science pop-up at the top of the Color Management panel in the Project Settings. This setting lets you use LUTs that were created for ACES workflows that are similar to (but not the same as) LUTs you would create and use in a traditional log-encoded workflow. LUTs designed for working with this setting should have a range of –0.358 to 1.468 so that grading operations that clip an image from 0 to 1 won’t destroy the look being applied.

The “ACEScc AP1 Timeline Space” setting is also good for workflows where you want to use conventional LUTs that were designed for Rec. 709 workflows using the ResolveFX “ACES Transform” plug-in, which over a series of three nodes lets you transform the image from ACES to 709, apply a Rec. 709-designed LUT, and then convert the image from 709 back to ACES.

- **ACES AP0 Linear**: This setting requires you to apply an LMT LUT that has been specifically created for ACES image data. Only use this setting if you’re using CLFs that are designed for ACES using a range of –65504 to 65504, as specified by SMPTE 2065.

Adding Lookup Tables of Your Own

The menus in the Color Management panel of the Project settings include a series of factory preset LUTs that were installed with DaVinci Resolve, along with any LUTs that have been generated by DaVinci Resolve, or that you've imported into the proper directory for your operating system for your own use.

By default, LUTs are saved to the following locations:

- **On OS X**: Library/Application Support/Blackmagic Design/DaVinci Resolve/LUT/
- **On Windows**: C:\ProgramData\Blackmagic Design\DaVinci Resolve\Support\LUT
- **On Linux**: /home/resolve/LUT

Custom LUT Paths

A list in the General panel of the DaVinci Resolve System Preferences lets you add multiple file paths for loading LUTs that you want to use in DaVinci Resolve. This works for network volumes for facilities where multiple workstations are accessing a central collection of LUTs to be shared among multiple artists. Clicking the Add button lets you add a file path to this table from a dialog. Selecting a location in this list and clicking Remove removes that location.
LUT Paths for the macOS App Store Version of DaVinci Resolve

If you downloaded the non-studio version of DaVinci Resolve from the Apple App Store, LUTs are saved in a different location in order for DaVinci Resolve to remain totally self-contained. In this case, you can click the Open LUT Folder button in the Lookup Tables panel of the Project Settings, to open up a Finder window at the location these LUTs are stored. You can use this window to copy LUTs that you want DaVinci Resolve to have access to, or delete LUTs that you no longer need.

If you add a LUT to one of these directories after DaVinci Resolve has been opened, you can click the Update Lists button to refresh the contents of the pop-up menus.

LUT Controls in the Project Settings

While there’s an entire group of LUT controls in the Color Management panel of the Project Settings, those are designed to apply LUTs, at different parts of the image processing pipeline, to the entire Timeline. This is useful when you want to apply a single color and contrast transformation to the entire program at once, but less so if you want to apply different LUTs on a per clip basis. For more information on using the Lookup Table settings, see Chapter 4, “System and User Preferences.”

Applying LUTs to Source Clips

Another way of applying a LUT to a clip is to apply it directly to the source clip, which you can do to any clip in the Media Pool, or in the Thumbnail Timeline of the Color page. This can be convenient, but keep in mind that source clip LUTs cannot be copied from one timeline to another using ColorTrace, so using source clip LUTs limits your potential workflows. For most workflows, it’s better to apply LUTs directly in the Node Editor so they live in each clip’s grade.

To apply a LUT to one or more selected clips in the Media Pool:
– Right-click one of the selected clips, and choose a LUT from the 1D LUT or 3D LUT submenus.

To apply a LUT to one or more selected clips in the Thumbnail Timeline of the Color page:
– Right-click one of the selected thumbnails, and choose a LUT from the 1D LUT or 3D LUT submenus.

**TIP:** If you’re wanting to apply an image transformation to normalize log-encoded source clips, you may also consider using Resolve Color Management (RCM). Depending on your source media, it may be an easier and more automated process. For more information, see Chapter 8, “Data Levels, Color Management, and ACES.”

Using the Color Page LUT Browser

The LUT Browser on the Color page provides a centralized area for browsing and previewing all of the LUTs installed on your workstation. All LUTs appear in the sidebar, by category.

By default, all LUTs appear with a test thumbnail that give a preview of that LUT’s effect, but you can also get a live preview of how the current clip looks with that LUT by hover scrubbing with the pointer over a particular LUT’s thumbnail (this is described in more detail below).
To open the LUT Browser:

– Click the LUT Browser button in the UI Toolbar at the top of the Color page.

Methods of working with the LUT Browser:

– To see the LUTs in any category: Click on a LUT category to select it in the sidebar, and its LUTs will appear in the browser area.

– To make a LUT a favorite: Hover the mouse over a LUT and click the star badge that appears at the upper right-hand corner, or right-click any LUT and choose Add to Favorites. That LUT will then appear when you select the Favorites category in the Node Editor contextual menu for nodes.

– To search or filter for specific LUTs: Open a bin that has the LUT you’re looking for, then click the magnifying glass icon to open the search field, and type text that will identify the LUTs you’re looking for.

– To see LUTs in Column or Thumbnail view: Click the Column or Thumbnail buttons at the top right of the LUT Browser to choose how to view LUTs in the browser area.

– To sort LUTs in Thumbnail view: Click the Thumbnail Sort pop-up menu and choose which criteria you want to sort LUTs by. The options are filename, type, relative path, file path, usage, date modified. There are also options for ascending and descending sort modes.

– To sort LUTs in Column view: Click the column header to sort by that column. Click a header repeatedly to toggle between ascending and descending modes.

– To update the thumbnail of a LUT with an image from a clip: Choose a clip and frame that you want to use as the new thumbnail for a particular LUT, then right-click that LUT and choose Update Thumbnail With Timeline Frame.

– To reset the thumbnail of a LUT to use the standard thumbnail: Right-click a LUT and choose Reset Thumbnail to go back to using the standard test image.

– To refresh a LUT category with new LUTs that may have been installed: Select a LUT category, then right-click anywhere within the browser area and choose Refresh to refresh the contents of that category from disk.
Enabling and Disabling the LUT Viewer live preview:

1. Open the LUT Viewer’s option menu and choose Live Preview.

The Live Preview option for the LUT browser lets you hover over a LUT to preview it on the current clip in the Viewer.

2. Click a node in the Node Editor you want to preview applying a LUT to. The live preview will display how the current clip will appear with the LUT you select applied to the currently selected node of the current grade, which will affect the result.

3. Move the pointer over the LUT you want to preview.
   The Viewer image updates to show how that clip would look with that LUT applied to the currently selected node.

To apply a LUT from the LUT Browser to a specific node, do one of the following:

- Right-click a LUT and choose Apply LUT to current node.
- Drag a LUT from the LUT Browser and drop it onto the node you want to apply a LUT to. If you drag a LUT onto a node that already has a LUT, the previous LUT will be overwritten by the new one.

Applying a LUT Within a Node

DaVinci Resolve lets you apply LUTs within a grade by connecting a LUT to a particular node in the Node Editor. This gives you the greatest amount of control over where the LUT is applied in your image processing pipeline, and it also gives you the opportunity to apply image adjustments prior to the LUT, and after the LUT, as you require.

To apply a LUT within a node, do one of the following:

- Right-click any node, and choose a LUT from the 1D Input LUT, 1D Output LUT, 3D LUT, DCTL, or CLF (common LUT format) submenus of the LUT submenu. The LUT submenus list whichever LUTs have been installed on your workstation. For more information on installing LUTs, see Chapter 4, “System and User Preferences.”
- Right-click any node, and choose a LUT from the LUT > Favorites submenu.
- Use the LUT Browser to find a LUT you want to use, and then drag and drop that LUT onto the node you want to apply it to

**TIP:** If you hold down the Option key while scrolling through the submenu of LUTs in a Corrector node’s contextual menu, you’ll get a live update in the Viewer of how each LUT affects the image.

To reveal a selected node’s LUT:

For any node in the Node Editor with a LUT applied to it, you can right-click that node and choose Reveal Selected LUT to automatically open the LUT viewer and select that LUT.
LUTs Are the Last Operation Within a Node

Each node in the Node Editor is capable of performing multiple operations, and these operations occur in a specific order. LUTs that you add to a node impose their transformation as the last operation within that node, after all other Color page adjustments applied by that node.

Practically, this means that you can use a node’s Color and Contrast controls to trim the image data that will be fed into a LUT applied to that same node. For example, if a LUT’s contrast adjustment clips the highlights of the image too much, you can use that node’s Contrast controls to lower the highlights of the image prior to the LUT, restoring detail to the image.

Favorite LUTs Submenu in Node Editor

When you “star” a LUT as a favorite in the LUT Browser, those favorite LUTs appear in a submenu of the contextual menu that appears when you right-click on a node in the Node Editor. This makes it easy to create a short list of your go-to LUTs for various situations, for rapid application right in the Node Editor.

Exporting LUTs

If you find it necessary to exchange image adjustments with other grading applications, compositing applications, or NLEs, often the easiest inter-application solution is to export a LUT. This can be done whether your grade consists of one node or several nodes, so long as they contain only Primaries palette adjustments, Custom Curves palette adjustments, and compatible ResolveFX plug-ins that include Color Space Transform, ACES Transform, and Gamut Mapping. All nodes with compatible functions will be mathematically combined and translated into a LUT.

Keep in mind that any nodes that use Qualifiers, Windows, incompatible filtering operations (such as sharpening or blurring), or incompatible Resolve FX or Open FX will be completely ignored, as will all other correction operations made within these nodes.

To export a LUT:

1. Right-click a clip thumbnail in the Timeline of the Color page, and choose an option from the Generate LUT submenu:
   - Generate 3D LUT (17 Point Cube): A DaVinci-developed LUT format
   - Generate 3D LUT (33 Point Cube): A DaVinci-developed LUT format
   - Generate 3D LUT (65 Point Cube): A DaVinci-developed LUT format
   - Generate 3D LUT (Panasonic VLUT): A LUT format associated with Panasonic VariCam cameras
2 Choose a location for the resulting LUT file in the file dialog. The default file path depends on your operating system; saving it here will make it available to DaVinci Resolve for future use.
   – **On OS X:** Library/Application Support/Blackmagic Design/DaVinci Resolve/LUT/
   – **On Windows:** C:\ProgramData\Blackmagic Design\DaVinci Resolve\Support\LUT
   – **On Linux:** /home/resolve/LUT

   If you like, you can create a new folder in which to save your custom LUTs.

3 Enter a name into the Save As field, and click Save. A LUT file is saved.

   Once created, you can use an exported LUT from within DaVinci Resolve, applying it to a clip or node directly, or applying it to the entire project using the settings found in the Color Management panel of the Project Settings. You can also copy the LUT to a memory stick to give to someone for monitoring or previewing in an onset workflow, or to someone using another grading application that can read this LUT format.
The DaVinci Resolve control panels make it easier to make more adjustments in the same amount of time than using a mouse, pen, or trackpad with the on-screen interface. Additionally, using a DaVinci Resolve control panel to control the Color page provides vastly superior ergonomic comfort to clutching a mouse or pen all day, which is important when you’re potentially grading a thousand shots per day.

This chapter covers details about the three DaVinci Resolve control panels that are available, and how they work with DaVinci Resolve.

Contents

About The DaVinci Resolve Control Panels 2888
The DaVinci Micro Panel 2889
The DaVinci Resolve Mini Panel 2889
The DaVinci Resolve Advanced Panel 2889
Updating the Control Panels Firmware 2890
Using the DaVinci Resolve Micro Panel 2890
Trackballs 2890
Control Knobs 2891
Control Buttons 2892
Using the DaVinci Resolve Mini Panel 2894
Palette Selection Buttons 2894
Quick Selection Buttons 2895
Using the DaVinci Resolve Advanced Control Panel (Legacy Layout) 2897
Menus, Soft Keys, and Soft Knob Controls 2897
Trackball Panel 2898
T-bar Panel 2899
About The DaVinci Resolve Control Panels

There are three DaVinci Resolve control panel options available and each are designed to meet modern workflow ergonomics and ease of use so colorists can quickly and accurately construct both simple and complex creative grades with minimal fatigue.

This chapter provides details of the each of the panel functions and should be read in conjunction with the previous grading chapters to get the best from your panel.
The DaVinci Micro Panel

The DaVinci Resolve Micro Panel is ideal for edit suites that need a professional grading panel for occasional grades or quick adjustments to shots. You will also find it on DIT carts and in video village situations on set where its small size, portability, and low power needs are ideal for teams on the move.

The DaVinci Resolve Mini Panel

For many facilities and individual operators, the DaVinci Resolve Mini Panel is a compact yet powerful grading panel that’s fully featured despite its small size. The bottom half of this panel is identical to the Micro Panel, making it easy for people upgrading from the Micro to leverage their existing muscle memory. However, the top half of this panel adds direct-selection palette keys, dynamically remapped soft knobs and buttons, and a paged menu system that offers considerably more flexibility than the Micro Panel, and a better overall grading experience as a result.

The DaVinci Resolve Advanced Panel

The ultimate grading panel to give you the speed for long and complex grading sessions, and to make a lasting impact on clients visiting your suite or looking in on you as they’re videoconferencing during a remote grading session. The DaVinci Resolve Advanced control panels features dozens of fixed palette keys and menu driven soft knobs and buttons so most grading operations are just a keystroke or two away. High resolution liquid crystal displays (LCD) and backlit keys accommodate a typical darkened grading environment, with LCD panel and key color and intensity being user customizable, so each colorist can set up their preferred panel configuration.
The original key configuration for the DaVinci Resolve Advanced Panel was updated in late 2020 to add new features and capabilities, while eliminating redundancy and making better use of the full complement of available buttons. Owners of the original panel can update to the new layout, but both the original and new layout are described in separate sections of this chapter.

**Updating the Control Panels Firmware**

From time to time, Blackmagic updates the functionality of the Control Panels through firmware changes. New firmware for the Micro and Mini Panels can be checked for and installed by opening the separate DaVinci Control Panels Setup utility that is installed by default with DaVinci Resolve. Firmware for the Advanced Panel is updated directly from DaVinci Resolve automatically.

**Using the DaVinci Resolve Micro Panel**

The Micro Panel features a row of direct control knobs at the top of the panel, three trackballs with rings for color grading, and to the right, transport and commonly used keys to speed up your grading session. Above the trackballs are reset buttons and also mode selection buttons for Log, Offset, and the Viewer selector. When selecting the Viewer mode, the full display will switch to the Cinema Viewer which is ideal for playback and review of clips. The Log and Offset selections are described below.

**Trackballs**

The three trackballs, from left to right, are in the traditional DaVinci format of Lift, Gamma, and Gain when DaVinci Resolve is set for Primary grading. This is the default mode for the panels but you can quickly toggle to Log mode using the LOG key just above the center trackball. When in Log grading, the trackballs control the Lowlights, Midtones, and Highlights.

You can also select the OFFSET button whether in PRIMARY or LOG modes. This is a toggle operation and when selected the left hand side ring surrounding the trackball controls the color temperature of the image, the center trackball ring the color tint, and the right hand side trackball controls the image offset balance and master exposure with the ring.

By rotating the trackball the colorist can alter the balance between the red, green, and blue levels of the image. Using the vectorscope as a rough guide, moving the trackball towards the three-thirty clock position adds more blue while reducing the red and green.
The control ring surrounding these trackballs provides a master amplitude control of the associated trackball.

**Above the three trackballs are three buttons for resetting the grade:**

- **RGB**: This key only resets the RGB balance to default detent.
- **All**: Select All to reset both RGB and level.
- **Level**: Select the Level key to reset the level while maintaining RGB differential.

![Log, Offset, Viewer, and Trackball reset buttons](image)

**Control Knobs**

The top of the panel features 12 high resolution endless turn optical encoder control knobs with detent resets. These are spaced in groups of three for fast operation in dark suites. From left to right the knobs control:

![Control Knobs](image)

- **Y Lift**: This knob is for adjusting the contrast of the image in the darker areas. The midtone and to a lesser amount the brighter areas of an image will also change.
- **Y Gamma**: Use the gamma knob for primarily midtone contrast changes with some influence on the darker and brighter sections.
- **Y Gain**: The Y Gain control influences the brighter parts of the image at a greater extent to the mid and darker portions.

- **Contrast**: This one parameter lets you increase or reduce the distance between the darkest and lightest values of an image, raising or lowering image contrast. The effect is similar to using the Lift and Gain master controls to make simultaneous opposing adjustments.

- **Contrast Pivot**: Changes the center of tonality about which dark and bright parts of the image are stretched or narrowed during a contrast adjustment.

- **Midtone Detail**: When this parameter is raised, the contrast of regions of the image with high edge detail is raised to increase the perception of image sharpness, sometimes referred to as definition. When lowered to a negative value, regions of the image with low amounts of detail are softened while areas of high detail are left alone.

- **Color Boost**: Lets you naturally raise the saturation of regions of low saturation, sometimes referred to as a vibrance operation. Can be used also to lower the saturation of regions of low saturation.

- **Shadow**: Lets you selectively lighten or darken shadow detail. Raising this value retrieves shadow detail recorded below 0 percent, while leaving the midtones alone. 0 is unity.

- **Highlight**: Makes it easy to selectively retrieve blown-out highlight detail in high dynamic range media by lowering this parameter, and achieves a smooth blend between the retrieved highlights and the unadjusted midtones for a naturalistic result.

- **Saturation**: Increases or decreases overall image saturation. At higher values, colors appear more intense, while at lower values, color intensity diminishes until, at 0, all color is gone, leaving you with a grayscale image.

- **Hue Rotation**: Rotates all hues of the image around the full perimeter of the color wheel. The default setting of 50 shows the original distribution of hues.

- **Luminance Mix**: Lets you control the balance between YRGB contrast adjustments you’ve made using the Master Wheels or ganged Custom curves, and Y-only adjustments to contrast made using the Y channel Lift/Gamma/Gain controls of the Primaries palette or the unganged Luma curve.

Additional detail can be found in the Color page basics chapter and each of these operations can be seen on the Primary palette of the user interface.

### Control Buttons

On the right hand side of the trackballs there are three groups of control buttons.
The top group includes:

- **Grab Still**: At any time when you are grading, selecting the Grab Still key automatically grabs a full resolution frame from the Timeline and attach the node graph metadata for later display and use.

- **Undo**: Undo is one of the favorite keys of colorists. Try any grade, and if you don’t like it, simply undo. There are multiple steps of undo available within the page.

- **Redo**: Sometimes you hit undo once too many times. Redo will put back into effect the last item you undid. As with undo, there are multiple levels of redo.

- **Play Still**: Using Play Still, DaVinci Resolve will automatically display a wipe on the Viewer between the current scene and the current still. You can use your mouse on the viewer to move the wipe position. Selecting Play Still a second time will toggle this mode off.

- **Prev Mem**: Each clip, by default, has a memory of its grade, sizing, and so on, which is saved in reference to the source timecode. If you are grading a clip and move from it to another clip, the grade is saved automatically in a memory for that clip. If you come back to the clip and make a change to the grade, then decide you don’t like the change, select Prev Mem to return to the previous grade status you found when selecting the clip.

- **Reset**: This key resets the grade of the current node. Holding down this key deletes all nodes in the clip except for the first node and resets the grades to default and clears the keyframes.

- **Loop**: You may wish to repeat a review of a grade of a clip, or a selection of clips on the Timeline; this Loop toggle key selects or deselects the Loop operation.

- **Bypass**: This toggle selects the node graph bypass mode.

- **Disable**: This toggle enables or disables the current node.

The middle group of buttons include:

- **Prev Node**: Within the Node Editor on the Color page you are likely to have a number of nodes. These are numbered based on the order that you added them. DaVinci Resolve node graphs are completely user configurable, so you can add nodes anywhere and in any order you like. Thus, the Previous Node key selects the node one lower in numerical order.

- **Next Node**: Similar to the Previous Node key, this selects the node adjacent to the current node, in this case the next higher numerical position.

- **Prev Frame**: To step the viewer one frame in reverse along the Timeline. Press and hold the Prev Frame button to go to the first frame of the clip.

- **Next Frame**: A single frame step forward for each key press. Press and hold the Next Frame button to go to the last frame of the clip.

- **Prev Clip**: Selects the first frame of the previous clip.

- **Next Clip**: Selects the first frame of the next clip.

The bottom group includes the Timeline Transport buttons for reverse play, stop, and play.

- **Left Arrow**: Select this key to play the clip/Timeline in reverse. Press the left arrow key multiple times to play in reverse at a faster speed.

- **Stop**: You guessed it. This stops the playback.

- **Right Arrow**: The forward key plays the clip/timeline forward. Press the right arrow key multiple times to play forward at a faster speed.
Using the DaVinci Resolve Mini Panel

The Mini Panel has an identical feature set and controls as the Micro Panel for the lower trackball deck. In addition the panel has an upper sloped desk with dual high resolution LCD displays with four soft knobs and keys that are menu driven. There are also two banks of control buttons, on the left hand side for palette selection and on the right hand side for commonly used operations.

Please refer to the Micro Panel details above for the lower deck features.

Palette Selection Buttons

On the left hand side of the top deck you will find 15 palette selection buttons. To quickly select the main palette toolsets in DaVinci Resolve simply select the appropriate button and the menus on the LCD screens will update to the correct display.

Palette selection buttons

- **Home**: This key is used for the initial setup of the panel and also selects the top-most menu. Additional palettes in DaVinci Resolve without their own direct access button will be available here in future releases.

- **Left Arrow**: A number of menus have multiple pages as indicated by the small dots in the center of the LCD displays. The left arrow moves the menu display left.

- **Right Arrow**: The right arrow moves the menu display right.

- **Raw**: This palette contains groups of parameters that correspond to every camera raw media format that’s supported by DaVinci Resolve.

- **Primary**: The first grade for every clip will be likely be a primary. This is where you balance the clip and correct for offsets in the black and white balance. Selecting Primary switches DaVinci Resolve from other grading modes and automatically selects the Primary menus for the LCD displays.

- **Motion**: The Motion Effects palette (only available in the Studio version) contains two sets of controls for applying optical-flow-calculated effects to clips in your program. These include enhanced Spatial and Temporal noise reduction, and motion-estimated artificial motion blur.
– **Curves:** The Curves palette has six modes that provide different curve-based methods of manipulating the color and contrast of an image. Each curve lets you adjust a customizable region of the image based either on image tonality (zones of lightness or darkness), hue (specific colors), or saturation (intensity of color).

– **Qualifier:** When you select and isolate a particular color, and change that color, you are making a secondary correction. The qualifier key updates the menus to provide all the Secondary controls, including the 3D, HSL, RGB, or Luma key, with which to isolate the correction you need.

– **Window:** Power Windows are another way of making secondary correction, being essentially shapes you can use to isolate regions of the image. Different controls let you use oval, rectangular, polygonal, or custom curved shapes. Because you can isolate regions of the image by drawing, Power Windows produce exceptionally clean results, with edges that can be precisely positioned and feathered to achieve a variety of effects.

– **Tracker:** The Tracker palette has three modes, available from the Palette menu. In Window mode, the tracking controls let you match the motion of a window to that of a moving feature in the frame. In Stabilizer mode, the same underlying technology is used to smooth or stabilize the motion within the entire frame, while in FX mode a point tracker can be used to animate Resolve FX or OFX plug-ins with positioning controls.

– **Blur:** With the Blur palette controls you can apply an exceptionally high-quality Gaussian blur, or another equally high-quality sharpening operation to your image.

– **Keyer:** Each color correction node’s key input and key output makes it possible to route key channel data from one node to another so you can apply isolated corrections. These key levels are controlled in the Keyer palette.

– **Sizing:** DaVinci Resolve has a powerful toolset for making geometric transforms, using advanced algorithms for optical-quality sizing operations and they are found in this palette.

– **Fx:** Control of the Resolve FX plug-ins from this palette will be available here in future releases.

– **User:** User configured menus will be available here in future releases.

### Quick Selection Buttons

On the right hand side of the top deck you will find 15 quick selection buttons. These are for very commonly used selections that a colorist might use many times for each clip.
– **Serial**: The most common node to use on the node graph is a Serial node. A Serial node is a full-featured color correction processor offering primaries, secondaries, windows, tracking, image stabilization, sharpening and blur, matte blur, and so on. Serial nodes are added one after the other in a cascade mode, similar to adding one layer of correction on top of the last. All grades in a preceding node(s) will impact the source image and therefore the grades in following nodes.

– **Parallel**: Unlike adding a Serial node, adding a Parallel node first actually adds two nodes. One behaves like a Serial node with full color correction capabilities. The second is a Parallel Mixer node. This mixer accepts the image from the original Serial node and from the new Serial node and the output is a mix of these two. If the current node is one of the Serial nodes immediately preceding the Parallel Mixer node and you select Add Parallel again, another input to the mixer will be created as will another preceding Serial node. In each case, the input to these Serial nodes will be common, effectively making them in parallel to each other. The key advantage is that the source image is available to many nodes, whereas in a straight Serial node graph, each time you restrict a color in a node the following nodes have little ability or limited range to use that color.

– **Layer**: The Layer node is similar to the Parallel node in that it accepts the image inputs from more than one node. The key difference to a Parallel node is that the mixing of the inputs in a Layer node is prioritized towards the latest additions to the input list. For example, select Add Layer and DaVinci Resolve will add a node in parallel to the current node and link the output of the current and the newly made Parallel node to the two inputs of the Layer Mixer node. The previous current node will have the lowest priority in the mix, and the newly made Parallel node the highest priority. Add one more Layer node, a third input node will be created with a higher mix priority than the first two nodes.

– **Node + Linear**: Adds a Serial node after the current node on the node graph and simultaneously adds a Linear Power Window, thus reducing the number of keystrokes.

– **Node + Circle**: Adds a node after the current node on the node graph and simultaneously adds a Circular Power Window.

– **Append**: Often when navigating around the Node Editor and making correction trims, the colorist decides he/she needs an additional node for more correction. Using the Append Node key will always add a Serial node to the very end of the node graph, regardless of which node in the graph is the current node.

– **Copy**: Used to copy a selected nodes grade to another node.

– **Paste**: Use this key to complete the copy/paste of node grade.

– **Full Viewer**: The Full Viewer display shows an enlarged Viewer and this includes transport controls at the bottom, timecodes and the selections for Reference Still modes, split screens, and Highlight modes.

– **Prev Still**: If you have a still selected, the Previous Still key selects the one preceding.

– **Next Still**: The next still is selected if this key is used.

– **Highlight**: When in the Qualifier menus making secondary qualifiers, it’s common to select the Highlight key to show a high contrast separation of the qualified color and all other parts of the image. Toggle this key to turn off.

– **Prev KF**: This key steps backward one keyframe on the Clip/Track Timeline display.

– **Next KF**: For keyframe steps forward on the Clip/Track Timeline display.

– **Ref**: This toggle key changes the reference wipe mode between Gallery, Timeline, and Offline sources.
Using the DaVinci Resolve Advanced Control Panel (Legacy Layout)

**IMPORTANT**

For information on the new version of the DaVinci Resolve Advanced control panel, see the next section. This section covers the previous version of the Advanced Panel for legacy owners.

There are three panels in the Advanced control panel set. The center Trackball panel is where the majority of controls and feedback for the colorist are found and it includes a slide-out keyboard.

On either side of the Trackball panel are two interchangeable panels, the position of which is determined by operator preference. The T-bar panel, shown above on the left, has a T-bar Mix/Wipe control and a number of menu and function keys. The Search Dial panel, shown above on the right, has the Timeline Transport controls and a Jog/Shuttle control as well as a numerical keypad and associated function keys.

All panels have soft keys and variable control knobs within the LCD panel, which provide an accurate visual reference to the control without the risk of parallax errors.

A key feature of the panel design is real-time feedback, provided to the colorist via the full color LCD panels where you can see, at a glance, the relative settings of the controls and a highlight of the last control touched. For example, if a control is out of its default reset, the panels show this with a selectable color highlight.

**Menus, Soft Keys, and Soft Knob Controls**

The soft menu structure is designed to offer simultaneous control over multiple functions and a fast, logical, and efficient way to move between the menus. These soft menus, the soft keys, and the operation of these in conjunction with the variable knobs are covered in the preceding chapters of this manual as their state changes depending on the operation being performed.

You will find the LCD on each of the panels has a two-line title description of the menu’s main function and there are two lines of text above each pot or switch describing the control. The T-bar and Search Dial panels also have a “More” key to the bottom right of the LCD which will select a second layer of menus.

The T-bar and Search Dial panels have quite independent controls compared to the Trackball panel. For example, the T-bar panel’s default menu is for Windows adjustment while the default menu for the Search Dial panel is Sizing. This allows users to control windows or sizing at any time, regardless of the Trackball panel mode and eliminates the need to change the work surface to adjust window position or input sizing.

While the menus change with the UI, the hard keys, trackballs, T-bar, and shuttle control remain relatively constant, so the majority of this chapter describes groups and individual key functions. At the end of this chapter are details on copying forward, scrolling, and rippling changes using the Advanced control panel.

**Shift Key Convention**

Before describing the hard key operation, it is important to understand two keys on the left and right panels. These keys, Shift Up and Shift Down, provide access to potentially two more functions on each of the next key selected.
For example, on the T-bar panel, next to the Shift Up key is the Base Mem key. The term “Base Mem” is a legacy DaVinci colorist description to revert to the default memory, so there is no grade or sizing on that node. (There is an exception discussed later in this chapter.)

If you select Shift Up and then Base Mem, the All operation is to Base Mem All or reset the current color correction of every node in the node graph for the current clip, leaving the nodes in place. To “Reset” the selected node graph or “Reset Grades and Nodes,” first select Shift Down, then Base Mem.

To permit a fast and single-handed operation, this function does not require you to hold the Shift Up or Shift Down key while selecting the second key; just select them sequentially, first the Shift key, then the function.

**Trackball Panel**

The Center panel has the traditional four trackballs, each with a surrounding control ring and no end stop in either direction. Three variable knob controls are on each side of the panel, three keys above the trackballs, three below the leftmost and rightmost trackballs. On the LCD panel, there are three LCD displays, each with eight knob controls and four keys. The LCD screens are menu driven and thus the knobs, soft keys, and the display itself depends on the application’s current operation. The Center panel also offers a slide-out keyboard for naming files, stills, and nodes, as well as for a number of other operations.

The three trackballs, from left to right, are in the traditional DaVinci format of Lift, Gamma, and Gain when DaVinci Resolve is set for Primary grading; when in Log grading they are Lowlights, Midtones, and Highlights.

By rotating the trackball the colorist can alter the balance between the red, green, and blue levels of the image. Using the vectorscope as a rough guide, moving the trackball towards the three-thirty clock position adds more blue while reducing the red and green.

The control ring surrounding these trackballs provides a master amplitude control of the associated trackball.

The Trackball panel includes a slide-out keyboard
Above the three leftmost trackballs you will see three buttons for resetting the grade:

- **RGB**: This key only resets the RGB balance to default detent.
- **All**: Select All to reset both RGB and level.
- **Level**: Select the Level key to reset the level while maintaining RGB differential.

The rightmost (fourth) trackball has a number of modes. It operates similar to a mouse for moving the onscreen cursors, Color curve control point position, and Power Windows position, and can also act as a primary grade Offset control.

Under the leftmost and rightmost trackballs there are three unmarked buttons.

On the left hand side of the panel, the right-most of the three unlabelled buttons below the trackball toggles the right hand side (fourth) trackball in and out of offset adjust mode.

The keys under the right-hand side trackball provide left, center, and right mouse buttons.

Above the rightmost trackball, the three keys have two modes.

When used in conjunction with the Shift Down button, the three buttons above the trackball function as resets, as per the buttons above the other trackballs.

- **Shift Down Adjust Window**: Only resets the RGB balance to default detent.
- **Shift Down Modes**: To reset both RGB and level.
- **Shift Down Cursor**: To reset the level while maintaining RGB differential.

In their normal operation they select:

- **Adjust Window**: Selection turns on the Viewer Shape cursors for the current node and allows the trackball to position the current window.
- **Modes**: This key allows access to a number of menus and acts as an on/off toggle.
- **Display (Shift Up Cursor)**: This shift function changes the cursor views on the main monitor. The user can select the cursor display, including: Windows, Off, On the UI but not the main SDI monitor, or displayed on both.
- **Cursor**: The Cursor is used for the color picker when in Curves and Vector/Secondary modes. This key also controls the Window display.

On the left side of the panel are three luminance knobs. From top to bottom they are Luminance Gain, Gamma, and Lift.

On the right side there are three more controls, from top to bottom: Saturation, Hue (has the effect of hue rotation), and Luminance Mix.

**T-bar Panel**

The T-bar panel, typically located on the left for a right-handed colorist, has an LCD display with four variable controls and nine soft keys. The lower section of the panel houses the T-bar and six groups of hard keys. Each group and their keys are described below.

**Mode Control Group**

The Mode Control group provides navigation to a number of the GUI pages and a few commonly used functions.

- **Config**: This key opens the Project Setting window where you will set up DaVinci Resolve for each project. Select again to close the window without saving.
- **Browse**: Select Browse to call the Media page where you can review files on attached storage and review the Media Pool.
– **VSR (Shift Down Browse):** This selection is reserved for future use.

– **Conform:** Selects the Lightbox display on the Color page.

– **Shift Up Conform:** Toggles the display of the Lightbox on the SDI output.

– **Deck (Shift Up Revival):** The Deck key selects the Capture mode for importing a batch list from an EDL.

– **Revival:** This key opens the Revival Dirt and Dust-busting window.

– **Scene (Shift Down Revival):** To select the Scene Cut Detection window, select the Shift Down key followed by the Revival key.

– **Current “Viewer:** This key toggles between the Color page and the Enhanced Viewer page.

– **Object Track Mode:** This key selects the Tracking menus.

– **Clip/Track/Unmix:** This is a toggle key between the Clip/Timeline modes of the node graph and the Unmix mode.

– **User (Shift Up Cache Mode):** This marks a clip for render cache of the clip output.

– **Cache:** This key is a toggle function to turn the render cache on or off.

– **Editor:** Selects the Edit page where you can edit the Timeline, import AAF, EDL or XMLs and apply speed changes, Composite and Dissolve/Wipe effects, and so on.

– **Proxy On/Off:** This key toggles the proxy mode on and off.

– **Auto Color:** This is a popular key. Using this key, DaVinci Resolve will automatically make a basic primary color correction to balance the blacks and whites of your image.

– **Page Up (Shift Up Gallery):** In larger projects you may have a number of gallery albums holding stills. This key changes the Gallery page to the next higher album on the list.

– **Gallery:** Used to select the Gallery UI page where you can manage, import, and export your stills.

– **Page Down (Shift Down Gallery):** The inverse of the Shift Up Gallery function, this selects the Gallery album one lower than the current.

– **A/C Mode:** This toggle key displays the clips in the Timeline in the order of the EDL (the record order, often referred to as C Mode), or the ascending order of the source clip timecode, called A Mode.

– **Handles Mode:** This selection exposes the handles of the selected clip to allow tracking and grading outside the I/O selections of the current edit.

**Timeline Management Group**

When grading clips, colorists often try different looks. This group of keys offers a quick way to navigate through these versions and to split and join clips on the Timeline.

– **Split (Shift Up Undo):** This key splits the clip at the position of the cursor on the Timeline.

– **Undo:** Undo is one of the favorite keys of colorists. Try any grade, and if you don’t like it, simply undo. There are multiple steps of undo available within the page.

– **Join (Shift Up Redo):** The reverse of split. Place the Timeline cursor at the junction of two clips that have sequential timecode and select Join to make just one clip.

– **Redo:** Sometimes you hit undo once too many times. Redo will put back into effect the last item you undid. As with undo, there are multiple levels of redo.

– **Restore Point:** This selection is reserved for future use.

– **Save:** Remember this key; it’s your friend. Save often, and also consider the auto save options found in the User Preferences.
Add Version: When you make a grade on any clip, DaVinci Resolve stores the parameters for that clip. If you want to try different grades, don’t lose your good grades, just use the Add Version feature. This key makes a second, third, or higher version of the grade for that clip.

Default Version: If you have multiple versions of grades for a clip, this key is used to select the Default version, regardless of which version is currently displayed.

Previous Version: This selects the grade one version lower in order. For example, if you are on version three, select Previous Version to get to version two. Once the Default version is reached, selecting Previous Version again will select the highest version.

Next Version: Use this key to select the next higher version of the grade. Once the top version is reached, selecting Next Version again will select the lower version.

Keyframing Group
On the bottom right of the Color page is the Keyframe timeline for the current clip. The Keyframing group of keys is used in association with the Keyframe timeline and controls the selection of marks for the start and end of dynamic transitions of the grade.

Start Dynamic: Use Start Dynamic to select the first keyframe in a transition. The transition may be a grade change, resizing, the addition of a matte, or any number of 100 variables, all of which are associated with the node graph and the Clip or Track timeline.

Ripple Value: If you have a grade or effect, or just an adjustment, and you would like to ripple this effect over another effect or over a large number of other clips, use Ripple Value.

Delete: This key deletes the selected keyframe.

Lift Mark: If you place a keyframe in the wrong spot, put your cursor on the keyframe and use Lift Mark to remove it.

Trim: This key is used with the numerical keypad to trim a keyframe’s position.

Mark: Like the Start Dynamic key, Mark is a major key. It places a Static keyframe on the Keyframe timeline.

Scene (Shift Down Mark): This selection opens the Scene Cut Detector.

Memory Access Group
DaVinci Resolve has a number of hot keys, called Mems, where you can store a grade for quick reference. In fact, every time you make a grade for a clip, a memory of the grade is kept. While you could save a still for each clip, having thousands of stills to scroll through would take time, so there are 26 quick and easy memory locations to store a grade, called A–Z Mems.

Every clip has its own metadata for the grade that is stored by DaVinci Resolve as a memory. There are a number of keys available to select or revert to these stored metadata memories, or to clear the metadata to revert to a base grade or no grade state.

All (Shift Up Base Mem): This is used to reset the current color correction of every node in the node graph for the current clip, leaving the nodes in place.

Base Mem: Used to reset the grade of the current node.

Reset (Shift Down Base Mem): Used to reset the grades of the current clip.

Please note that there is an exception to the rule to clear the Base Mem. It is possible, in fact very helpful sometimes, to have a clip preset that is not cleared when you select Base Mem. For example, when a film is over scanned and the frame edges are shown as well as the image. Instead of making an input resize adjustment for every clip to remove the framing, a preset resize can be made and stored, with a label, and this preset is not deleted when using Base Mem.
– **Preview Mem:** To preview one of the Memory grades on any clip, select the clip on the Timeline, select Preview Mem and then the Memory letter. This key is a toggle so if you do not like the grade on the memory for that clip, select Preview Mem again and the grade will revert to the original.

– **Original Mem:** Each clip by default has a memory of its grade and sizing, etc. If you are grading a clip and move from it to another clip, the grade for the first clip is saved automatically in a memory for that clip. If you come back to that clip and make a change to the grade, then decide you don’t like the change, select Original Mem to return to the grade status you found originally.

– **Scroll:** When you select Scroll you can navigate up and down the Timeline to find and select a clip and its grade to recall to the current clip.

– **View (Shift Up Current):** The Color page has two display modes. The normal mode includes the viewer, stills, and node graph on the top of the page. Selecting View toggles to the alternate page with a wide Node Graph view and stills but no viewer. Select View again to toggle back to the normal mode.

– **Cnt:** Select Current before selecting a Mem key (A, B, C to Z) and the current grade on the active Timeline clip will be stored in the memory selected.

– **Shift Up:** The Shift Up key permits the operator to select the upper secondary function of keys on the control panel. This operation does not require you to hold the Shift Up key, just select it prior to the second key.

– **Shift Down:** The Shift Down key permits the operator to select the lower secondary function of keys on the control panel. This operation does not require you to hold the Shift Down key, just select it prior to the second key.

– **Macro:** This key displays the Split Screen controls on the T-bar panel LCD display.

– **Memory Keys:** The A, B, C to Z keys, selected directly or with the appropriate Shift Up or Shift Down preselection will recall the grade stored in this memory and will apply it automatically to the clip that is active on the Timeline.

**Menu Navigation and Node Control Group**

DaVinci Resolve is a nodal-based color enhancement system. Grades are not stored in layers, but in nodes. In operation they can appear to be in layers if you select the Serial nodes, but greater grading flexibility is available by using the Parallel and Layer nodes.

This group also gives you quick access to the main menus to control primaries, secondaries (known here as Vectors), image sizing, and windows. It also offers a quick way to add and manage nodes.
– **Primary**: The first grade for every clip will be likely be a primary. This is where you balance the clip and correct for offsets in the black and white balance. Selecting Primary switches DaVinci Resolve from other grading modes and automatically selects the Primary and Custom Curve menus for the LCD displays.

– **Vectors**: When you select and isolate a particular color, and change that color, you are making a secondary correction. The Vectors key updates the menus to provide all the Secondary controls, including the hue selection and control.

– **Sizing**: The input and output image resizing engines are controlled using the menus selected by Sizing.

– **Windows**: The Windows key opens the menus for Circular, Linear, Polygon, PowerCurve, and Gradient windows that can be used as a matte or mask for primary and secondary grades.

– **Outside Node**: Selecting the Outside Node key adds another node after the current node and automatically link both image and key paths. If the original node has a grade within the matte shape the new Outside node would control the grade in the inverse (i.e., outside the matte).

– **Add Matte**: Selecting this key displays the Matte node on the node graph for the selected node and the default matte selected.

– **Disable Current**: This key is a toggle key and it disables or enables the grade on the current node.

– **Delete Current**: To delete the current node. Remember to use undo if you had the wrong node selected.

– **Bypass (Shift Up Disable Current)**: This toggle selects the bypass mode.

– **Enable/Disable All (Shift Down Disable Current)**: This toggle enables or disables all nodes.

– **Node + CPW**: Adding a Serial node is a one button selection, Add Serial, but to also add a window requires a number of extra key selections. The Node + CPW key adds a node after the current node on the node graph and simultaneously adds a Circular Power Window, thus reducing the number of keystrokes.

– **Node + LPW**: As above, adds a Serial node after the current node with a Linear Power Window.

– **Node + PPW**: A Polygon Power Window is also selected when adding a Serial node.

– **Node + PCW**: This key, like the others above, adds a Serial node after the current node, but also sets up the PowerCurve Window to permit the marking of freeform shape points and Bezier spline curves on the viewer to construct a freeform window.

– **Add Serial**: The most common node to use on the node graph is a Serial node. A Serial node is a full-featured color correction processor offering primaries, secondaries, windows, tracking, image stabilization, sharpening and blur, matte blur, and so on. Serial nodes are added one after the other in a cascade mode, similar to adding one layer of correction on top of the last. All grades in a preceding node(s) will impact the source image and therefore the grades in following nodes.

– **Shift Down Add Serial (Add Serial Before)**: This adds a serial node before the current node.

– **Add Parallel**: Unlike adding a Serial node, adding a Parallel node first actually adds two nodes. One behaves like a Serial node with full color correction capabilities. The second is a Parallel Mixer node. This mixer accepts the image from the original Serial node and from the new Serial node and the output is a mix of these two. If the current node is one of the Serial nodes immediately preceding the Parallel Mixer node and you select Add Parallel again, another input to the mixer will be created as will another preceding Serial node. In each case, the input to these Serial nodes will be common, effectively making them in parallel to each other. The key advantage is that the source image is available to many nodes, whereas in a straight Serial node graph, each time you restrict a color in a node the following nodes have little ability or limited range to use that color.
Add Layer: The Layer node is similar to the Parallel node in that it accepts the image inputs from more than one node. The key difference to a Parallel node is that the mixing of the inputs in a Layer node is prioritized towards the latest additions to the input list. For example, select Add Layer and DaVinci Resolve will add a node in parallel to the current node and link the output of the current and the newly made Parallel node to the two inputs of the Layer Mixer node. The previous current node will have the lowest priority in the mix, and the newly made Parallel node the highest priority. Add one more Layer node, and a third input node will be created with a higher mix priority than the first two nodes.

Append Node: Often when navigating around the Node Editor and making correction trims, the colorist decides he/she needs an additional node for more correction. Using the Append Node key will always add a Serial node to the very end of the node graph, regardless of which node in the graph is the current node.

Reference Configuration Group
This area of the T-bar panel includes six keys and the fader T-bar. It is primarily used for control of stills display with and without reference wipes. The fader bar controls the mix or wipe position when the appropriate mode is active.

- **Key**: This key adds and Alpha output on the node graph.
- **Circle**: This key is not yet implemented.
- **Wipe**: The Wipe key selects a wipe for reference comparison with the current image.
- **H/V**: This key toggles the wipe between horizontal and vertical.
- **Box**: This key is not yet implemented.
- **Mix**: Select this key to mix in preference to wipe.
- **Still**: The Still key permits comparison of the current clip with the selected still.
- **Memory**: Use this key to compare the current clip with a memory.
- **Highlight**: When in the Qualifier (Vector) menus making secondary qualifiers, it’s common to select the Highlight key to show a high contrast separation of the qualified color and all other parts of the image. Toggle this key to turn off. Highlight is used so often it’s also on the T-bar panel and, when in Vectors mode, on the Trackball panel.
- **Mode (ShiftDownHighlight)**: Used to toggle the Highlight mode from gray to high contrast.
- **Timeline**: Select the Timeline key when you want to compare the current to the Timeline image.
- **Offline**: Select the Offline key when you want to compare the current to the Offline image.
- **Reference On/Off**: This toggle key will turn the reference view on or off. When on, you can see the current clip in comparison to a reference.

Search Dial panel
The Search Dial panel, typically located on the right for a right-handed colorist, has an LCD display with four variable controls and nine soft keys. The lower section of the panel houses the Jog/Shuttle knob and six groups of hard keys. Each group and their keys are described below.

Reference Configuration Group
Located at the top left-hand side of the Search Dial panel are the Deck and Still selection keys. These are all related to controlling the tape deck and to grabbing and selecting stills. There is also an Undo and Redo key, a Shift Up and a Save key.

- **Split (Shift Up In)**: DaVinci Resolve associates grading information based on source timecode so it’s important to have each source clip identified as a different clip from the others. The Split key will split one clip into two on the frame selected. Each can therefore have its own grade. This is a quick, accurate, and easy way to split a long image sequence into multiple clips.
– **In:** When marking an In point you can use the UI, a keyboard shortcut, or this key.

– **Join (Shift Up Out):** Join is the reverse of the Split key. If you have clips with contiguous timecode, place the playhead on the first frame of a clip and select Join to merge the preceding clip.

– **Out:** The Out key is used to select an Out point on the Timeline or deck.

– **Duration:** To define a duration, first select the time using the numerical keypad (the colon separates the hours, minutes, seconds, and frames), and then select Duration.

– **Gang:** This key is not implemented.

– **Undo:** The colorist’s friend. DaVinci Resolve has virtually unlimited undo steps available within the page you are working in.

– **Redo:** If you want to redo a step, use redo. Ideal when used with undo to compare two grades quickly.

– **Source (L):** This key is not implemented.

– **Place (Shift Up A ( R )):** This key is not implemented.

– **A ( R ):** This key is not implemented.

– **F:** This key is not implemented.

– **Place (Shift Up B):** This key is not implemented.

– **B:** This key is not implemented.

– **G:** This key is not implemented.

– **Place (Shift Up C):** This key is not implemented.

– **C:** This key is not implemented.

– **H:** This key is not implemented.

– **D:** This key is not implemented.

– **I:** This key is not implemented.

– **E:** This key is not implemented.

– **J:** This key is not implemented.

– **Shift Up:** Use the Shift Up key as a pre-selector for the keys with an upper option. Select the keys sequentially and do not hold the Shift Up key while selecting the second key.

– **Preroll:** The Preroll key is used in conjunction with the numerical keypad to select a preroll time for tape operations.

– **Cue:** Selecting Cue will force the transport to the preroll position.

– **Previous Still:** If you have a still selected, the Previous Still key selects the one preceding.

– **Next Still:** The next still is selected if this key is used.

– **Play Still:** Using Play Still, DaVinci Resolve will automatically display a wipe on the Viewer between the current scene and the current still. You can use the fader T-bar to move the wipe position and in the Reference Wipe menus change the reference image as required by moving or resizing. Selecting Play Still a second time will toggle this mode off.

– **Save:** The most important key on the panel. Besides using the auto-save feature, you can and should consistently save your project with this key. It only takes a few seconds and can save you hours.

– **Grab Still:** At any time when you are grading, selecting the Grab Still key will automatically grab a full resolution frame from the Timeline and attach the node graph metadata for later display and use.
Transport Control Keys Group

Most colorists will use the Transport Control keys every minute of every grade, so they are located for quick and easy access. While not technically within this key group, the Jog/Shuttle knob is directly above these keys.

- **Jog**: Rotate the Jog control to step forward or backward a few frames at a time.
- **Shuttle**: On the outside of the Jog rotary control is the Shuttle knob. This knob has a detent at the null position and is turned clockwise or counter clockwise to shuttle the Transport/Timeline forward or reverse at the rate selected by the rotation of the Shuttle knob.
- **Loop**: You may wish to repeat a review of a grade of a clip, or a selection of clips on the Timeline; this Loop toggle key selects or deselects the Loop operation.
- **Render**: Once you have finished your grade, the Render key selects the Deliver page used for configuring the render parameters for your project and starting the render.
- **Rec**: (Shift Down Render) This key is not yet implemented.
- **Previous Node**: Within the Node Editor on the Color page you are likely to have a number of nodes. These are numbered based on the order that you added them. DaVinci Resolve node graphs are completely user configurable, so you can add nodes anywhere and in any order you like. Thus, the Previous Node key selects the node one lower in numerical order.
- **Next Node**: Similar to the Previous Node key, this selects the node adjacent to the current node, in this case the next higher numerical position.
- **Highlight**: When in the Qualifier palette making secondary qualifiers, it’s common to select the Highlight key to show a high contrast separation of the qualified color and all other parts of the image. Toggle this key to turn on or off. Highlight is used so often it’s also on the T-bar panel.
- **Mode**: (Shift Down Highlight) Used to toggle the Highlight mode from gray to high contrast.
- **Shift Down**: This is the preselection key for functions indicated on the lower portion of the second keys legend.
- **First Frame**: Selects the first frame of the current clip.
- **Last Frame**: Selects the last frame of the current clip.
- **Step Reverse**: To step the viewer one frame in reverse along the Timeline.
- **Step Reverse Keyframe**: (Shift Down Step Reverse) This key steps backward one keyframe on the Clip/Track Timeline display.
- **Step Forward**: A single frame step forward for each key press.
- **Step Forward Keyframe**: (Shift Down Step Forward) For keyframe steps forward on the Clip/Track Timeline display.
- **Previous Scene**: Selects the first frame of the previous scene.
- **Next Scene**: Selects the first frame of the next scene.
- **Rewind**: Places the Transport, or Timeline, in rewind.
- **Reverse**: Select this key to play the Clip/Timeline in reverse.
- **Stop**: You guessed it. This stops the current transport operation.
- **Forward**: The Forward key will play the Clip/Timeline forward.
- **Fast Forward**: The inverse of the Rewind key; fast forward shuttles along the Timeline/Transport.
Memory Access Keys Group

For fast and direct access to A to Z Memories, or Mems, use this section of the Search Dial panel. This is an extremely powerful feature. With any clip selected on the Timeline, with a single key press, for example "A," the grading parameters stored in memory A, including the node structure, sizing, and so on are automatically applied to the current clip.

- **O (Shift Up A):** Selects memory O.
- **A:** Selects memory A.
- **I (Shift Down A):** Selects Memory I.
- **R (Shift Up B):** Selects memory R.
- **B:** Selects memory B.
- **J (Shift Down B):** Selects Memory J (and so forth).
- **All (Shift Up Base Mem):** This function returns all grades for all nodes on the clip to the default grade/settings and clears dynamic keyframes.
- **Base Mem:** The Base Mem key clears the current node of all its grades and keyframes. Again, with the preset exception noted above.
- **Reset (Shift Down Base Mem Cnt):** This key deletes all nodes in the clip except for the first node and resets the grades to default and clears the keyframes.
- **Preview Mem:** To preview one of the memory grades on any clip, select the clip on the Timeline, select Preview Memory and then the memory. This key is a toggle, so if you do not like the grade on the memory for that clip, select Preview Mem again and the clip's grade reverts to the original.
- **Original Mem:** Each clip, by default, has a memory of its grade, sizing, and so on, which is saved in reference to the source timecode. If you are grading a clip and move from it to another clip, the grade is saved automatically in a memory for that clip. If you come back to the clip and make a change to the grade, then decide you don't like the change, select Original Mem to return to the previous grade status you found when selecting the clip.
- **Scroll:** The Scroll key selects a soft menu on the Trackball panel so clips or frames can be scrolled via the rotary control in the soft menu.

Numerical Entry Key Group

On the center right-hand side of the Search Dial panel is the Numerical Entry key group. Here you will find numbers 0 to 9 and associated keys for entering timecode and clip numbers. You will notice the numbers you type are displayed in a scratchpad area at the bottom of the Keyframe palette.

- **Current:** To store a new grade in any memory, first select the Current key and then the memory of your choice.
- **All Color PTZR:** This key is a toggle that selects the parameters that will be copied when updating a grade. Generally, all aspects of the grade are copied, including the pan, tilt, zoom, and rotation sizing transforms, but on occasion you may wish to copy only the grade and not the sizing parameters. In this case, use the All/Color/PTZR to select the mode you need. You can see the Keyframe Timeline toggle between the master or the node selected and the input PTZR parameters.
- **Select Node:** Use this key in conjunction with the numerical keys to select any node on the current node graph. First, select the node number, and then Select Node. The current node changes to the selected node.
- **Backspace:** The Backspace key moves you one item left in the numerical scratch pad display. This permits correction of your numerical entries.
– **0 to 9:** You guessed it. These are the numbers!
– **> (Comma):** The comma is used just before the frame count if you wish to indicate a drop frame timecode.
– **: (Colon):** When typing in timecode, the convention is to type the hours followed by a colon, then the minutes, a colon, the seconds, a colon, and finally the frames. DaVinci Resolve does not need to have leading numbers entered where they offer no value and the default value is 0, so to type one hour, three minutes, zero seconds, and sixteen frames, you do not need to type 01:03:00:16. Simply type 1:3::16 and then press Enter. This speeds timecode entry.
– **Clear:** Clears the scratchpad number.
– **- (Minus):** Select the Minus key prior to the number to reduce the number.
– **+ (Plus):** Select the Plus key prior to a number to increase the number.
– **Take/Enter:** Select the Take/Enter key to accept or enter any input.

**Keyframing Group**
The Keyframe keys are on the bottom right-hand side of the Search Dial panel. The functions are replicated on the T-bar panel. On the bottom right of the Color page is the Keyframe timeline for the current clip in the Timeline. The Keyframe group of keys is used in association with the Keyframe timeline and controls the selection of keyframes for the start and end of dynamic transitions of the grade.

– **Start Dynamic:** This key is used to select the first point in a transition, a Dynamic keyframe. The transition may be a grade change, a sizing or reposition, or the addition of a matte or any number of 100 variables, all of which are associated with the Node Editor and the Clip or Track Keyframe timeline.
– **Ripple Value:** If you have a grade or effect, or just an adjustment and you would like to ripple this effect over another effect or a large number of other clips, use Ripple Value.
– **Delete:** This key deletes the keyframe.
– **Lift Mark:** If you place a keyframe in the wrong spot, put your cursor on the keyframe and use Lift Mark to remove it.
– **Trim:** This key is used with the numerical keypad to trim a keyframe position.
– **Mark:** Like the Start Dynamic key, Mark is a major key. It places a Static keyframe on the Clip timeline.
– **Scene (Shift Down Mark):** This selection is reserved for future use.

**Copying Grades Using the Advanced Control Panel**
There are a number of methods of copying grades that are exclusive to the Advanced control panel.

**Copy Forward Keys**
The simplest way of copying grades using the control panel is to use the comma and colon keys on the keypad of the Search Dial panel to copy grades from one or two clips behind the currently selected clip. This is a great way to copy grades in scenes with a shot-reverse-shot structure, where you’re cutting between two angles of coverage, each of which uses the same grade.

– **To copy a grade from one clip back:** Press Comma (,).
– **To copy a grade from two clips back:** Press Colon (:).
Scroll

Scroll mode lets you quickly preview the effects of many different grades applied to clips in the Timeline on the currently selected clip, with the option to either accept or reject the previewed grade to which you’ve “scrolled.” This can be useful for checking to see if any of the previous grades you’ve created in a scene will work for the currently selected clip.

To use Scroll mode:

1. Move the playhead to the clip to which you potentially want to copy a new grade. You can use the PREV SCENE and NEXT SCENE buttons to move quickly.

2. Do one of the following to enter Scroll mode:
   - Press SCROLL on the Search Dial panel.
   - Press MODES, above the fourth trackball on the Center panel, then press the SCROLL MODE soft key.

3. Now, do one of the following to preview different grades from other clips:
   - Press the PREVIOUS SCENE and NEXT SCENE soft keys to move from clip to clip in the Timeline, previewing each grade to the current clip.
   - Turn the SCROLL SCENES knob to scroll smoothly along multiple clips in the Timeline.
   - Turn the SCROLL FRAMES knob to scroll along different frames of any clip, previewing the effects of keyframed grades at different points in time.
   - Press the TOGGLE DECK KEYS soft key to use the transport controls on the Search Dial panel to play through the Timeline, previewing grades as you go.
   - Press a number on the keypad of the Search Dial panel, and then the SCENE NUMBER soft key, to jump to a clip and preview its grade.
   - As you scroll from clip to clip, a red outline indicates the clip with the grade being previewed, and an orange outline indicates the current clip to which you’re previewing each scrolled grade.

4. When you’re finished, do one of the following to either accept or reject a scrolled grade:
   - Press EXIT AS WAS if none of the grades you scrolled through was suitable. This exits Scroll mode and leaves the clip as it was previously.
   - Press EXIT AS IS if you’ve found a grade that works for the current clip. This exits Scroll mode and copies the scrolled grade.

When you press the TOGGLE DECK KEYS soft key in Scroll mode, each of the Transport Control buttons on the Search Dial panel functions as a means of previewing the grades of other clips in the Timeline.

- **STEP FWD**: Move to the next clip and preview its grade.
- **STEP REV**: Move to the previous clip and preview its grade.
- **FWD**: Plays (scrolls) forward at 1 scene per second, previewing each new grade as it appears.
- **REV**: Play (scrolls) the clips in reverse at 1 scene per second, previewing each new grade as it appears.
- **FFWD**: Shuttles (scrolls) forward through the Timeline at 4 scenes per second, previewing each new grade as it appears.
- **RWD**: Shuttles (scrolls) reverse through the Timeline at 4 scenes per second, previewing each new grade as it appears.
Rippling Changes Using the Advanced Control Panel

DaVinci Resolve has a mechanism for rippling specific changes made to one clip to a range of other clips in the Timeline. This is only possible using the controls of the DaVinci Resolve Advanced control panel.

The general idea of the ripple function is that you select a clip, make a change, and then ripple that change to a range of other clips. This rippled change can be applied to the same node in each clip, or the change can be added as an appended node within each rippled clip.

The Ripple mode that's used when you press the RIPPLE VALUE button can be changed in the Color panel of the User Preferences. There are four options.

- **Exact values changed:** Changes made to the current clip are rippled to the specified clips using the exact parameters that were changed. For example, if Lift in the current clip is changed to 0.75 of its range, each clip you ripple will have a Master Gain setting of 0.75. Only parameters you adjust are rippled.

- **Percent value changed:** Changes made to the current clip are rippled to the specified clips by the percentage of change you made to the altered parameters. For example, if the current clip has a Lift level of 1.00 and is changed to 0.90 units, then the Lift setting of each clip you ripple will have a relative reduction of 10% relative to its previous value.

- **Unit value changed:** Changes made to the current clip are rippled to the specified clips by the same delta of change, using whichever units make sense for the affected parameter. For example, if the current clip had a Lift of 0.80 and you increased it to 0.90, each rippled scene's master gain level increases by 0.10.

- **All values are copied:** The current clip's grade is rippled to the specified clips in its entirety. No comparison is made with the original clip's parameters, and all memory parameters are rippled.

The following procedure describes in detail how you can use the control panel to ripple a change to a range of other clips. While this procedure may appear complicated, it’s just that there are several options. Once you learn the sequence of commands, this process is actually quite fast.

**To ripple a change using the Ripple Mode soft key commands:**

1. (Optional) Press MODES, then press RIPPLE MODES. Four commands appear mapped to the middle soft keys of the Center panel, which can be used later to execute different types of ripple operations.

2. Move the playhead to the clip you want to adjust.

3. Adjust the current clip that you want to ripple to other clips in the Timeline.

4. Define the range of clips you want to ripple to using the number pad on the Search Dial panel. The following combinations will work:
   - An absolute range of clips is defined by entering two clip numbers separated by a comma. For example, if you want to ripple the current change to clips 10 through 15, you’d press “10, 15”
   - To specify every clip from the beginning of the Timeline, use the Minus (–) key. For example, to specify a range of clips from the beginning to clip 20, you’d press “–, 20”
   - To specify every clip to the end of the Timeline, use the Plus (+) key. For example, to specify a range of clips from the clip 50 to the end, you’d press “50, +”
   - To specify every clip in the whole Timeline, press “–, +”

5. (Optional) You can control whether the rippled change is applied in an appended node, or an existing node, in every rippled clip:

   If you want to apply the rippled change as a new node that's appended to the end of every rippled clip's grade, press SHIFT DOWN.
Otherwise, the rippled change will be applied to the same node in every rippled clip that you made your adjustment to in the current clip. In other words, if you made a change to Node 2, it would be rippled to Node 2 of all the clips you specified. If one of the rippled clips doesn’t have the same number of nodes, you may get an error.

6 To execute the ripple, do one of the following:

Press RIPPLE VALUE on the Search Dial panel to ripple a change using the currently selected Ripple Mode in the Color panel of the User Preferences.

Press one of the Center panel soft keys corresponding to the ripple function you want to perform. There are four soft keys:

- **Static Ripple**: Changes made to the current clip are rippled to the specified clips using the exact parameters that were changed. For example, if Lift in the current clip is changed to 0.75 of its range, each clip you ripple will have a Master Gain setting of 0.75. Only parameters you adjust are rippled. Identical to the “Exact values changed” ripple setting.

- **Relative Ripple**: Changes made to the current clip are rippled to the specified clips by the percentage of change you made to the altered parameters. For example, if the current clip has a Lift level of 1.00 and is changed to 0.90 units, then the Lift setting of each clip you ripple will have a relative reduction of 10% relative to its previous value. Identical to the “Percent value changed” ripple setting.

- **Absolute Ripple**: Changes made to the current clip are rippled to the specified clips by the same delta of change, using whichever units make sense for the affected parameter. For example, if the current clip had a Lift of 0.80 and you increased it to 0.90, each rippled scene’s master gain level increases by 0.10. Identical to the “Unit value changed” ripple setting.

- **Forced Ripple**: The current clip’s grade is rippled to the specified clips in its entirety, overwriting all previous nodes and parameters in the rippled clips.

The adjustment you made in step 4 is applied to the designated range of clips.

Admittedly, that was a long and detailed procedure, but the actual button sequences are straightforward once you put them together. Here are some examples of button sequences that ripple an adjustment you’ve just made in different ways:

- **“10, 15” then SHIFT DOWN then RIPPLE VALUE**: Copies the change you’ve made to the current clip, and applies it as a new node that’s appended to the end of clips ten through fifteen.

- **MODES then RIPPLE MODES then “34, 45” then FORCED RIPPLE**: Copies the entire grade of the current clip, using it to overwrite the grade of clips 34 through 45.

- **MODES then RIPPLE MODES then “–, +” then SHIFT DOWN then RELATIVE RIPPLE**: Copies the change you’ve made to the current clip as a relative percentage, and applies it as a new node appended to the end of every single clip in the entire Timeline.

**WARNING**

Once you ripple a change in this manner, there is no going back. Since undo is a per-clip operation, there is no global undo for changes made to the entire Timeline. Proceed with caution.
Using the DaVinci Resolve Advanced Control Panel (2020 Layout)

In late 2020, an updated and radically re-imagined key layout was introduced for the DaVinci Resolve Advanced Control Panel. This updated layout accounts for new features and controls, updates command terminology, eliminates redundancy, and takes fuller advantage of every key on every panel. The result is to provide maximum functionality, so you can work faster and more efficiently.

1. T-bar panel  
2. Trackball panel  
3. Search Dial panel

All three panels have LCD panels that display menus for the soft knobs and buttons.

Three Panels Working Together

The Advanced control panel set consists of three modular panels that work together to provide full functionality. The biggest panel with the trackballs is meant to sit in the center, while the two smaller panels are interchangeable depending on operator preference. These three panels are:

- **Trackball panel:** This central panel is where the majority of controls for the colorist are found. In addition to the trackballs, fixed keys, and fixed rotary knobs on the bottom portion, there are soft keys and rotary knobs on the top angled portion. The Trackball panel also includes a slide-out keyboard underneath.

- **T-bar panel:** Shown at the left, this smaller panel has a greater concentration of fixed keys and a T-bar Mix/Wipe control that can be used for a variety of different functions on the bottom portion, and a smaller set of soft keys and rotary knobs on the top angled portion.

- **Search Dial panel:** Shown at the right, the bottom portion of this smaller panel also has a greater concentration of fixed keys, a Jog/Shuttle control with fixed Timeline Transport buttons underneath, and a fixed button numeric keypad that can be used for node and shot navigation, timecode entry, and which can also be used for whole, half, and quarter Printer Points adjustments when the P/Lite mode is activated. The top angled portion has a smaller set of soft keys and rotary knobs.

The smaller two panels connect to the Center panel via an integrated USB hub, and the Center panel connects to your workstation via USB 2.

On all three panels, the fixed keys and specialized mechanical/optical controls are located on the bottom flat area. The operator-facing top area has all of the dynamically assigned soft keys and rotary controls, located atop an LCD panel which provides dynamic labeling and visual references for each soft control, all angled to be visible to the operator without parallax errors. These soft control displays also provide real-time feedback where you can see the relative settings of each variable control knob at a glance.
The Trackball panel includes a slide-out keyboard

Using Fixed Keys and Shift Up/Shift Down Functions

As the name implies, fixed keys offer unchanging functionality for frequently used functions. They’re arranged in clusters of like-minded functionality in an effort to make it easy to access a variety of related controls in one place that’s easier to remember. For example, all the keyframing controls are clustered together at the bottom-right of the Search Dial panel, next to the fixed transport controls which are clustered together at the bottom-left of the Search Dial panel (under the Jog/Shuttle wheel).

However, just because they’re fixed doesn’t mean they’re limited. Many, if not most, of the fixed keys offer one or two alternate functions, appearing above and below the primary function.

Each fixed key can list as many as three different functions; the main function appears at the center, the SHIFT-UP function appears at the top of the key, and the SHIFT-DOWN function appears at the bottom of the key.
The primary function of each fixed key, which is what happens when you simply press it, is displayed at the center in slightly larger text. Every key has at minimum one primary function. In the key shown above, ADD GROUP is the primary function that will be executed when you press the key once, so selecting a number of clips in the Thumbnail Timeline and then pressing this key would create a new group containing all selected clips.

For keys that have them, the alternate commands of fixed keys are accessed using SHIFT UP and SHIFT DOWN keys, a pair of which are located on each of the three panels.

Pressing SHIFT UP gives you access to whichever alternate fixed key commands are displayed at the top. To help you see which keys have SHIFT UP functionality, pressing SHIFT UP illuminates all keys having an alternate function with a different color. In the key shown previously, pressing SHIFT UP will illuminate this key with another color to let you know it’s ready to use, and then pressing this key executes the JOIN function, adding the currently selected clip in the Thumbnail Timeline to the current group.

Pressing SHIFT DOWN works similarly, to illuminate and give access to alternate fixed key commands displayed at the bottom of buttons that have them. In the key shown previously, pressing SHIFT DOWN and then this key would execute the REMOVE function, removing the currently selected clip in the Thumbnail timeline from whichever group it belonged to.
(Top) The default lit keys of the Search Dial panel. (Bottom) Pressing SHIFT DOWN highlights all keys with alternate SHIFT DOWN functions so you can instantly see which keys are selectable.
In many cases, including the previous examples, the multiple functions assigned to a particular fixed key are related to one another to make them easier to remember. The primary function of each key is usually the most common function you’d want to perform, while the alternate functions are related to it.

In other cases, alternate functions aren’t directly related to the primary function, but they’re in the same general category of activity. This is true of the “Pages and Layout” group of buttons at the top-left of the T-bar panel, for which the primary function of each button gives access to the main pages of DaVinci Resolve you might want to switch among (this is particularly useful if you’re hiding the bottom button bar of the user interface in order to get more screen real estate while working), while the SHIFT UP and SHIFT DOWN functions let you access specific GUI panels or page customization options that are related to those pages.

**Soft Menus, Including Soft Keys and Soft Rotary Controls**

Each of the three panels have soft controls. These controls appear on top of an LCD display that provides a top-most two-line title/description of each soft menu’s main function, along with two lines of text above each soft rotary control or soft key that describes that control’s specific function.

The soft controls on the center Trackball panel typically update to show context-specific controls for whichever mode and palette is currently selected. The buttons and rotary controls are designed to offer simultaneous control over multiple related functions in each palette. They also provide a logical way to navigate among multiple sets of controls in palettes that have many modes or in modes that have more controls than can be represented on the Center panel’s 24 rotary and 12 key controls.

![Soft Menu Controls](image)

(Top) The Trackball panel’s soft menu controls corresponding to the Primaries palette, (Bottom) the soft menu controls corresponding to the Motion Effects palette; note how all the controls update to be contextual to the palette that’s currently in use.

The T-bar and Search Dial panels each have soft controls consisting of four rotary and eight key controls, plus one additional unlabeled “More” key at the bottom right of the LCD. Ordinarily, the More key toggles between the default layout for that panel and additional sets of controls that there isn’t room for.
The unlabeled “More” key found to the bottom left of each of the side panel soft menu controls lets you choose an alternate or second set of controls for that panel’s current menu.

One of the nicest aspects of the soft controls is that the T-bar and Search Dial panels provide simultaneous access to the controls of other palettes than the currently selected palette displayed in the Trackball panel. For example, the T-bar panel’s default soft menu is the Sizing palette, while the default soft menu for the Search Dial panel is the Curves palette. These defaults let you make adjustments to image sizing or contrast curves at any time, regardless of what’s currently displayed on the Trackball panel’s soft controls, giving you access to multiple palettes’ worth of controls at once for the ultimate in efficiency.

Changing Which Palettes Appear in the Side Panel Soft Controls

However, there’s another benefit to the soft controls on these side panels; you can choose which Color page palette’s controls appear on each side panel, directly from the control surface.

To change a side panel’s soft controls to another palette:

1 Press SHIFT UP on any panel.
2 Press the MORE key on the T-Bar panel or the Search Dial panel.
   Once you do so, the fixed keys corresponding to palettes that can be displayed on the side panels are highlighted on the Trackball and T-bar panels. This shows you which palettes can be assigned.
3 Press the key corresponding to the palette you want to assign. For example, if you want to expose the controls of the Qualifier palette, press the QUALIFIER button.

The selected side panel soft menu updates to show the controls of the palette that you assigned. If there are more controls on that palette than can be displayed at once (which is likely), press the MORE key to cycle among all of the available controls in that palette.

For example, if you want to assign the Motion palette’s controls to the T-bar panel because you’re adding a lot of noise reduction to the clips of the program you're working on, simply press SHIFT UP, then the T-bar panel’s MORE key, then the MOTION key on the Trackball panel. Now the Motion palette’s controls appear on the soft menu of the T-bar panel, and you can use the MORE button to cycle among each page of available controls. If you want to go back the the default arrangement, the two default assignments are the Sizing palette on the T-bar panel, and the Curves palette on the Search Dial panel.

Why Aren’t the Soft Panels Specifically Documented

Because of their dynamically remappable nature, the soft controls will continue to evolve over subsequent versions of DaVinci Resolve along with the palettes and functions they control. For this reason, soft control assignments are not presented in-depth as the fixed keys are. Instead, you’re best off referring to the Color page documentation in the Color Page section of the DaVinci Resolve User Manual to figure out what each identically named control is used for. All you need to know for now is that the soft controls change depending on which palette is selected, the mode of each palette, and the operation being performed.
The Trackball Panel

The focus of the Center panel is four trackballs that work as color balance controls in various palettes of the DaVinci Resolve Color page. Their functionality depends on which palette is currently open. Each trackball has a surrounding control ring that has no end stop in either direction, letting you do continuous rotary adjustment. The rings typically are for adjusting image lightness and contrast in different ways but are sometimes used for other functions, depending on which Color page palette you have selected.

Additional buttons above and below the trackballs, and fixed-function rotary controls to the left and right, complete the center control cluster that provide a predictable set of central controls for making color and contrast adjustments.

Using Trackballs

The principal palettes you’ll use the trackballs with are the Color Wheels and Log Wheels modes of the Primaries palette, and the Global and Zones controls of the HDR palette. Whichever of these modes and palettes is selected will determine the functionality of the trackballs and rings.

However, keep in mind that whichever color controls the trackballs are assigned to, the topmost soft controls on the Trackball palette can be switched to work with other palettes, such as the Motion, Curves, or Qualifier palettes, for example. This means you can adjust the controls of a second palette while simultaneously making color and contrast adjustments with the trackballs and ring controls. This is exceptionally useful when making two kinds of adjustments that interact with one another.

Summarizing the Top Fixed Keys

Each of the four trackball/ring controls has three fixed keys above it. Individually, these keys provide separate Y and RGB reset controls for each trackball/ring pair. However, the first nine of these keys
also collectively serve as a fast and convenient way of navigating the principal panels of grading functionality in the Color page.

Additionally, the left-most trackball has a pair of shift keys underneath it for choosing which button function to trigger, giving you fast access.

**Trackball and Ring Reset Controls**

Each trackball’s reset controls are protected by having to press SHIFT UP to use them. This may feel like an extra step at first, but now that this top row of keys is also used to quickly switch among different palettes on the Color page, using SHIFT UP protects you from accidentally pressing a reset when you meant to switch to another palette. If you’re used to the prior layout, this will take a bit if getting used to, but it isn’t so bad once you’ve built up the muscle memory.

**Reset controls above each trackball when pressing SHIFT UP:**

- **RGB:** Resets red, green, and blue channel adjustments while leaving master level (luminance or Y) adjustments alone.
- **All:** Resets both RGB channel and master level adjustments.
- **Level:** Resets master level adjustments while maintaining the differential between the RGB channels (aka color balance).

**Navigation controls above each trackball (primary and SHIFT DOWN functions)**

One of the biggest departures from the previous layout is the introduction of palette switching functions on the top row of fixed keys. This makes it faster to switch among different sets of controls as you work, and frees up additional buttons on the T-bar panel to do other things, adding to the utility of the DaVinci Resolve Advanced panel.
The first nine fixed keys above the trackballs work together to provide palette and mode switching.

<table>
<thead>
<tr>
<th>Key</th>
<th>Shift Up</th>
<th>Primary Function</th>
<th>Shift Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAW/USER</td>
<td>(RGB) Resets red, green, and blue channel adjustments only leaving master level adjustments alone</td>
<td>(RAW) Opens the Camera Raw palette</td>
<td>(USER) Not yet implemented at the time of this writing</td>
</tr>
<tr>
<td>LOG/S3D</td>
<td>(ALL) Resets all YRGB adjustments</td>
<td>(LOG) Opens the Log mode of the Primaries palette</td>
<td>(S3D) Opens the Stereo 3D Palette for Stereo 3D timelines</td>
</tr>
<tr>
<td>PRIMARY/&gt;SDR</td>
<td>(LEVEL) Resets master level adjustments, leaving the differential between red, green, and blue channels unchanged</td>
<td>(PRIMARY) Opens the Color Wheels mode (Lift, Gamma, and Gain) of the Primaries palette</td>
<td>(&gt;SDR) Opens the Dolby Vision™ palette if it’s enabled in the Project Settings</td>
</tr>
<tr>
<td>HDR/MIXER</td>
<td>(RGB) Resets red, green, and blue channel adjustments, only leaving master level adjustment alone</td>
<td>(HDR) Opens the High Dynamic Range (HDR) palette</td>
<td>(MIXER) Opens the RGB Mixer palette</td>
</tr>
<tr>
<td>MOTION/OPEN FX</td>
<td>(ALL) Resets all YRGB adjustments</td>
<td>(MOTION) Opens the Motion Effects palette</td>
<td>(OPEN FX) Opens the Magic Mask palette</td>
</tr>
<tr>
<td>CURVES/WARPER</td>
<td>(LEVEL) Resets master level adjustments, leaving the differential between red, green, and blue channels unchanged</td>
<td>(CURVES) Opens the Curves palette to the last used curve (all other curves can be accessed via soft menu buttons)</td>
<td>(WARPER) Opens the Color Warper palette</td>
</tr>
<tr>
<td>Key</td>
<td>Shift Up</td>
<td>Primary Function</td>
<td>Shift Down</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------</td>
<td>-------------------------------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>QUALIFIER/BLUR</td>
<td>(RGB) Resets red, green, and blue channel</td>
<td>(QUALIFIER) Opens the Qualifier palette to the last</td>
<td>(BLUR) Opens the Blur palette</td>
</tr>
<tr>
<td></td>
<td>adjustments, only leaving luminance channel</td>
<td>used Qualifier (you can choose which qualifier to use</td>
<td></td>
</tr>
<tr>
<td></td>
<td>adjustment alone</td>
<td>via soft menu buttons)</td>
<td></td>
</tr>
<tr>
<td>WINDOW/TRACKER</td>
<td>(ALL) Resets all YRGB adjustments</td>
<td>(WINDOW) Opens the Window palette</td>
<td>(TRACKER) Opens the Tracker palette to the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>last used mode</td>
</tr>
<tr>
<td>SIZING/KEY</td>
<td>(LEVEL) Resets master level adjustments,</td>
<td>(SIZING) Opens the Input Sizing mode of the Sizing</td>
<td>(KEY) Opens the Key palette</td>
</tr>
<tr>
<td></td>
<td>leaving the differential between red, green,</td>
<td>palette (Edit and Output Sizing can be accessed via</td>
<td></td>
</tr>
<tr>
<td></td>
<td>and blue channels unchanged</td>
<td>soft menu buttons)</td>
<td></td>
</tr>
</tbody>
</table>

The Tools Button

A TOOLS button at the bottom center of the left-most trackball provides fast access to a soft menu that provides additional options using the soft controls. This is a future-proofing feature and exposes no additional functionality at the time of this writing.

The TOOLS button under the left-most trackball
The Fourth Trackball

Depending on which palette you’re using in the Color page, the rightmost (fourth) trackball can be used for color adjustment in conjunction with the first three when acting as an Offset control in the Color Wheels and Log Wheel mode of the Primaries palette, or it can be toggled between Global controls or being the fourth Zone color control in the HDR palette.

However, the fourth trackball can also be set to perform many other functions using the three keys above and three keys below it. By choosing the appropriate palette and mode, it can be used as an eyedropper when sampling colors for qualification, it can be used to create, select, and adjust the control points of adjustment curves, or it can be used to adjust the position and rotation of Power Windows. All of these functions are described in the following table.

The fourth trackball gives access to additional functionality via the fixed keys above and below it.

<table>
<thead>
<tr>
<th>Key</th>
<th>Shift Up</th>
<th>Primary Function</th>
<th>Shift Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>RGB/ADJ WIN/SDI ZM</td>
<td>(RGB) Resets red, green, and blue channel adjustments, only leaving master level adjustments alone</td>
<td>(ADJ WIN) Lets the trackball adjust the position of the selected window, while the ring adjusts window angle. This key remains illuminated as long as this mode is enabled</td>
<td>(SDI ZM) Toggles “Gang viewer zoom with video output” on and off, letting the SDI output mirror pan and zoom being done in the Viewer</td>
</tr>
<tr>
<td>Key</td>
<td>Shift Up</td>
<td>Primary Function</td>
<td>Shift Down</td>
</tr>
<tr>
<td>-----</td>
<td>----------</td>
<td>------------------</td>
<td>------------</td>
</tr>
<tr>
<td>ALL/OVERLAY/VIEWER</td>
<td>(ALL) Resets all YRGB adjustments</td>
<td>(OVERLAY) Toggles onscreen control overlays, such as window outlines on and off for the Viewer and for video output. This key remains illuminated as long as this mode is enabled</td>
<td>(VIEWER) Sets onscreen control overlays, such as window outlines to be GUI only, so they only appear in the Viewer and not on video output</td>
</tr>
<tr>
<td>LEVEL/CURSOR/CURVE</td>
<td>(LEVEL) Resets master level adjustments, leaving the differential between red, green, and blue channels unchanged</td>
<td>(CURSOR) Toggles the eyedropper on and off for supporting palettes. In the Qualifier palette, the cursor lets you sample the image to create a key by pressing the SELECT button. In the Curves palette, you can sample the image to add a control point to the currently visible curve. This key remains illuminated as long as this mode is enabled.</td>
<td>(CURVE) Opens the Custom Curve and selects a control point to be freely adjusted (up, down, left and right) using the fourth trackball as you would the pointer in the GUI. Turning the ring to the left selects the next control point to the left, turning it to the right selects the next control point to the right.</td>
</tr>
<tr>
<td>SELECT/ALL</td>
<td>–</td>
<td>(SELECT) Used in conjunction with the CURSOR mode of the fourth trackball to sample a value for keying or for adding a control point to a curve</td>
<td>(ALL) Selects all clips in the Thumbnail Timeline</td>
</tr>
<tr>
<td>GLOBAL OFFSET</td>
<td>–</td>
<td>(GLOBAL OFFSET) In the Primaries palette, this sets the fourth trackball to adjust Offset color balance and Master levels. In the HDR palette, this sets the fourth trackball to adjust the Globals controls. This key remains illuminated as long as this mode is enabled.</td>
<td>–</td>
</tr>
<tr>
<td>AFTER/ENABLE/BYPASS</td>
<td>(AFTER) Disables/re-enables all nodes after the currently selected node</td>
<td>(ENABLE) Toggles the currently selected node (or nodes) off and on</td>
<td>(BYPASS) Toggles Bypass Grade on and off</td>
</tr>
</tbody>
</table>
Hard-Coded Rotary Knobs
There are an additional six rotary knob controls to either side of the trackballs, arranged three to the left and three to the right.

- On the left side, from top to bottom, the rotaries control Y-only luminance Gain, Gamma, and Lift settings of the Color Wheels and Color Bars modes of the Primaries palette that control lift, gamma, and gain. If you have any other palettes or modes open, using these three knobs will continue to affect the Lift, Gamma, and Gain controls of the currently selected node.

- On the right side, from top to bottom, the rotaries control Saturation, Hue, and Luminance mix. If you have any other palettes or modes open, using these two knobs will continue to affect the Saturation and Luminance Mix controls of the Color Wheels and Color Bars modes of the Primaries palette. The Hue knob will affect the hue of either the Primaries Palette mode or HDR palette, whichever was selected last.

Keyboard
The Center panel also offers a slide-out keyboard for naming files, stills, and nodes, triggering keyboard shortcuts, and writing novels about the innocence of newly hired colorists lost in the maelstrom of the film, television, and streaming industries.
The T-bar Panel

The T-bar panel, typically located on the left for a right-handed colorist, has an LCD display with four variable controls and nine soft keys. The lower section of the panel houses the T-bar control and six groups of hard keys. Each group and their keys are described below.

Pages and Layout Group

The Pages and Layout control group at left provides navigation to a number of the GUI pages and a few commonly used methods of opening and closing different panels to customize the Color page UI.

<table>
<thead>
<tr>
<th>Key</th>
<th>Shift Up</th>
<th>Primary Function</th>
<th>Shift Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>SETTINGS/PROJECT/NOTES</td>
<td>(SETTINGS) Opens and closes the Project Settings</td>
<td>(PROJECT) Opens and closes the Project Manager</td>
<td>(NOTES) Opens and closes the Project Notes window</td>
</tr>
<tr>
<td>STORAGE/MEDIA/METADATA</td>
<td>(STORAGE) Opens and closes the Disk Storage panel of the Media page</td>
<td>(MEDIA) Opens the Media page</td>
<td>(METADATA) Opens and closes the Metadata Editor on any page it appears</td>
</tr>
<tr>
<td>INSP/CUT/MEDIA</td>
<td>(INSP) Opens and closes the inspector on any page it appears</td>
<td>(CUT) Opens the Cut page</td>
<td>(MEDIA) Opens and closes the Media Pool on any page it appears</td>
</tr>
<tr>
<td>Key</td>
<td>Shift Up</td>
<td>Primary Function</td>
<td>Shift Down</td>
</tr>
<tr>
<td>-----</td>
<td>----------</td>
<td>------------------</td>
<td>------------</td>
</tr>
<tr>
<td>INDEX/EDIT/LIBRARY</td>
<td>(INDEX) Opens and closes the Edit Index</td>
<td>(EDIT) Opens the Edit page</td>
<td>(LIBRARY) Opens and closes the Sound Library on any page it appears</td>
</tr>
<tr>
<td>K/FM/FX/SPLINE</td>
<td>(K/FM) Opens and closes the Keyframe Editor on any page it appears</td>
<td>(FX) Opens and closes the Effects Library.</td>
<td>(SPLINE) Opens and closes the Spline Editor on any page it appears</td>
</tr>
<tr>
<td>DUAL VIEW/FUSION/NODES</td>
<td>(DUAL VIEW) Toggles between dual viewers mode and single viewer mode</td>
<td>(FUSION) Opens the Fusion page</td>
<td>(NODES) Opens and closes the Node Editor</td>
</tr>
<tr>
<td>GALLERY/COLOR/LUTS</td>
<td>(GALLERY) Opens and closes the Gallery</td>
<td>(COLOR) Opens the Color page</td>
<td>(LUTS) Opens and closes the LUT Browser</td>
</tr>
<tr>
<td>MIXER/FAIRLIGHT/METERS</td>
<td>(MIXER) Opens and closes the Mixer panel on any page it appears</td>
<td>(FAIRLIGHT) Opens the Fairlight page</td>
<td>(METERS) Opens and closes the Audio Meters panel on any page it appears</td>
</tr>
<tr>
<td>BURN/DELIVER/REMOTE</td>
<td>(BURN) Opens and closes the floating Data Burn In window</td>
<td>(DELIVER) Opens the Deliver page</td>
<td>(REMOTE) Turns on Remote Rendering for the current workstation</td>
</tr>
<tr>
<td>OFX/SCOPES/INFO</td>
<td>(OFX) Opens and closes the OFX Library/Settings panel on the Color page; when an effect is applied to the current node, toggles between the Library (list of OFX) and Settings (for the currently applied OFX)</td>
<td>(SCOPES) Opens and closes the Video Scopes window</td>
<td>(INFO) Opens the Clip Info palette</td>
</tr>
</tbody>
</table>
Layout and Modes Group
The Layout and Modes control group at right provides access to additional ways of customizing the UI and toggling different modes of functionality while you work.

The Layout and Modes keys give quick access to specialized Color page functions.

<table>
<thead>
<tr>
<th>Key</th>
<th>Shift Up</th>
<th>Primary Function</th>
<th>Shift Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>CLIPS/CLIP FILTER/--</td>
<td>(CLIPS) Turns the Thumbnail Timeline on and off in the Color page</td>
<td>(CLIP FILTER) Toggles the Thumbnail Timeline’s clip filtering between All Clips and whichever filter is currently selected; for example, if you choose “Selected Clips,” this toggles between All Clips and Selected Clips</td>
<td>–</td>
</tr>
<tr>
<td>PROXY/CACHE/OPTIMIZE</td>
<td>(PROXY) Toggles “Use proxy media if available” off and on</td>
<td>(CACHE) Toggles the effects cache among Smart Cache, User Cache, and Off</td>
<td></td>
</tr>
<tr>
<td>ACTUAL/DISPLAY MODE/FIT</td>
<td>(ACTUAL) Sets the size of the image in the Viewer to 100% so you can see the actual size of the image</td>
<td>(DISPLAY MODE) Toggle Display Mode switches between hiding and showing the Viewer to make more room for the Color page Node Editor</td>
<td>(FIT) Fits the entire image into the current size of the Viewer, zooming down or up as necessary</td>
</tr>
<tr>
<td>Key</td>
<td>Shift Up</td>
<td>Primary Function</td>
<td>Shift Down</td>
</tr>
<tr>
<td>-----</td>
<td>----------</td>
<td>------------------</td>
<td>------------</td>
</tr>
<tr>
<td>–/SWITCH TIMELINE/LOCK</td>
<td>–</td>
<td>(SWITCH TIMELINE) Cycles among all available timelines in the current project</td>
<td>(LOCK) Not yet implemented at the time of this writing</td>
</tr>
<tr>
<td>–/MIX UNMIX/HIDE TRK</td>
<td>–</td>
<td>(MIX UNMIX) Toggles Unmix on and off; when Unmix is on, each clip in the Color page is shown without transitions or compositing effects, making it easier for you to see your grade in effects heavy programs</td>
<td>(HIDE TRK) Hides all clips on whichever timeline track is currently displayed from the Thumbnail Timeline, so they’re ignored by the playhead, but continue to appear in video out; to show clips on that track again, you must Option-click the number of the track in the Mini Timeline to turn it back on</td>
</tr>
<tr>
<td>–/SCOPES MODE/SCALE</td>
<td>–</td>
<td>(SCOPES MODE) Cycles among all the available video scopes when the scopes are docked in the palette area</td>
<td>(SCALE) Toggles the video scopes between showing graphs with Video or Data levels</td>
</tr>
<tr>
<td>–/DUAL MON/PICKER</td>
<td>–</td>
<td>(DUAL MON) Turns the Workspace &gt; Dual Screen option on and off</td>
<td>(PICKER) Toggles the RGB color picker value option between 8- and 10-bit (View &gt; Show RGB Picker Values In &gt; 8- or 10-bit)</td>
</tr>
<tr>
<td>ENHANCED/LIGHTBOX/SDI OUT</td>
<td>(ENHANCED) Turns on Enhanced Viewer mode in the Color page, with the Viewer shown atop the palette controls</td>
<td>(LIGHTBOX) Toggles the Thumbnail Timeline Lightbox mode on and off</td>
<td>(SDI OUT) Toggles video output of the thumbnail Lightbox on and off</td>
</tr>
<tr>
<td>FLAGS OP/A/C MODE/SAFE</td>
<td>(FLAGS OP) Toggles the display of clip flags on SDI output</td>
<td>(A/C MODE) Toggles between A-sort and C-sort mode in the Thumbnail Timeline; in C-sort mode, clips are sorted by source timecode so similar clips appear together, in A-sort mode clips are sorted by record timecode so they appear in program order.</td>
<td>(SAFE) Toggles title safe on and off in the Viewer; options for title safe appear in the soft menu of the trackball panel</td>
</tr>
</tbody>
</table>
Utility Functions Group

This group of keys offers quick access to commonly used commands for saving, 3D functionality, Macros, and copy/paste functions for grading.

<table>
<thead>
<tr>
<th>Key</th>
<th>Shift Up</th>
<th>Primary Function</th>
<th>Shift Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>~/HANDLES/CODEC</td>
<td>–</td>
<td>(HANDLES) Turns “Show current clip with handles” on and off; this lets you see</td>
<td>(CODEC) Cycles among clips in the Thumbnail Timeline, showing the File Name,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the currently specified handles for the current clip in the Timeline, so you can</td>
<td>the Codec, and the Version number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>track windows and other effects into the handles of media being rendered for</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>round-trip workflows.</td>
<td></td>
</tr>
</tbody>
</table>

The Utility Functions keys provide access to a variety of frequently used utilitarian grading, Stereo 3D, and Macro commands.

<table>
<thead>
<tr>
<th>Key</th>
<th>Shift Up</th>
<th>Primary Function</th>
<th>Shift Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESCAPE/SAVE/SAVE AS</td>
<td>(ESCAPE)</td>
<td>(ESCAPE) The Escape key on a computer keyboard</td>
<td>(SAVE AS) Opens the Save Current Project As dialog, so you can save a</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>duplicate of the currently open project; change the name and click Save</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>when you’re done.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(SAVE) Issues the Save command for the current project; this is identical to</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>pressing Command-S</td>
<td></td>
</tr>
<tr>
<td>Key</td>
<td>Shift Up</td>
<td>Primary Function</td>
<td>Shift Down</td>
</tr>
<tr>
<td>-----</td>
<td>----------</td>
<td>------------------</td>
<td>-----------</td>
</tr>
<tr>
<td><strong>TAB/MUTE/DIM</strong></td>
<td>(TAB) The Tab key on a computer keyboard</td>
<td>(MUTE) Mutes audio monitoring; often useful when grading terrible programs</td>
<td>(DIM) Toggles between reducing and boosting the volume by 10dB; useful when the client wants to describe their next vacation</td>
</tr>
<tr>
<td><strong>LINK ZM/LEFT/RIGHT/OTHER</strong></td>
<td>(LINK ZM) For Stereo 3D timeline, toggles Convergence between Linked Zoom and Opposite</td>
<td>(LEFT/RIGHT) For Stereo 3D timelines, toggles between monitoring the Left or Right eye images</td>
<td>(OTHER) For Stereo 3D timeline, to “use the other eye”</td>
</tr>
<tr>
<td><strong>L&gt;R/GANG/SOLO/R&gt;L</strong></td>
<td>(L&gt;R) For Stereo 3D timelines, copies the left-eye grade to the right eye</td>
<td>(GANG/SOLO) For Stereo 3D timelines, toggles between ganging left- and right-eye grades together so changes to one are made to both, or soloing the left- and right-eye grades to make independent adjustments to each</td>
<td>(R&gt;L) For Stereo 3D timelines, copies the right-eye grade to the left eye</td>
</tr>
<tr>
<td><strong>LEARN/RECALL MACRO/–</strong></td>
<td>(LEARN) Not yet implemented at the time of this writing</td>
<td>(RECALL MACRO) Not yet implemented at the time of this writing</td>
<td>–</td>
</tr>
<tr>
<td><strong>START/END MACRO/–</strong></td>
<td>(START) Not yet implemented at the time of this writing</td>
<td>(END MACRO) Not yet implemented at the time of this writing</td>
<td>–</td>
</tr>
<tr>
<td><strong>COPY</strong></td>
<td>–</td>
<td>(COPY) Copies the grade of the current clip in its entirety, including all parts of group grades; you control what part of the copied grade is pasted using different commands.</td>
<td>–</td>
</tr>
<tr>
<td><strong>GRADE/PASTE/APPEND</strong></td>
<td>(GRADE) Pastes the entire copied grade to overwrite the previous grade; if you copied a group grade, the Pre-Clip, Clip, and Post-Clip grades are all pasted.</td>
<td>(PASTE) Pastes whichever node was the current node when the grade was copied to overwrite the current node’s settings; the current node is outlined orange.</td>
<td>(APPEND) Appends every node of the entire copied grade after the last node of the current grade; if you copied a group grade, the Pre-Clip, Clip, and Post-Clip grades are all appended as a flattened collection of nodes.</td>
</tr>
</tbody>
</table>
Clip and Version Group

These keys, at the bottom left of the T-bar panel, are used to manage clips and their grades in different ways, by creating and managing group assignments, clip attributes, and grade versions.

<table>
<thead>
<tr>
<th>Key</th>
<th>Shift Up</th>
<th>Primary Function</th>
<th>Shift Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>JOIN/ADD GROUP/REMOVE</td>
<td>(JOIN) Adds the current clip (or currently selected clips) to the current group (which is based on whichever group the last “grouped clip” you selected belonged to)</td>
<td>(ADD GROUP) Creates a brand new group and opens the Group Name dialog for you to type into (click OK to save the new group)</td>
<td>(REMOVE) Removes the current clip (or currently selected clips) from whichever group it belongs to</td>
</tr>
<tr>
<td>~CLIP ATTRIB/DETAILS</td>
<td>—</td>
<td>(CLIP ATTRIB) Opens the Clip Attributes window for the currently selected clip</td>
<td>(DETAILS) Toggles the floating Clip Details window open and closed, with which you can see various clip and grade properties for reference</td>
</tr>
<tr>
<td>~/FIND IN M/POOL/LIST</td>
<td>—</td>
<td>(FIND IN M/POOL) Selects the source clip in the Media Pool that corresponds to the current clip in the Timeline; opens the Media Pool to show the clip</td>
<td>(LIST) Switches the Media Pool to List view; the Media Pool does not automatically open if closed.</td>
</tr>
<tr>
<td>Key</td>
<td>Shift Up</td>
<td>Primary Function</td>
<td>Shift Down</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------</td>
<td>-----------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>PREV VERSION</td>
<td>–</td>
<td>(PREV VERSION) Cycles the grade of the current clip to the previously numbered version</td>
<td>–</td>
</tr>
<tr>
<td>NEXT VERSION</td>
<td>–</td>
<td>(NEXT VERSION) Cycles the grade of the current clip to the next numbered version</td>
<td>–</td>
</tr>
<tr>
<td>LABEL/ADD VERSION/&gt;LOCAL</td>
<td>(LABEL)</td>
<td>(LABEL) Opens the Version Name dialog, so you can rename the current version of the current clip; click OK when you're done.</td>
<td>(ADD VERSION) Adds an additional version of the grade for the current clip; you can create multiple versions of a grade to save variations for future recall.</td>
</tr>
</tbody>
</table>

Utility Group

This group of keys, in the center of the T-bar panel, includes commands for tracking and stabilization, enabling/disabling grades and nodes and OFX, and bypassing Fusion effects and Grades. These keys can also function as a numeric keypad for future features.
<table>
<thead>
<tr>
<th>Key</th>
<th>Shift Up</th>
<th>Primary Function</th>
<th>Shift Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHIFT UP</td>
<td>–</td>
<td>(SHIFT UP) Enables use of any of the SHIFT UP key functions at the top of various keys</td>
<td>–</td>
</tr>
<tr>
<td>1/CLIP/FM/+KF</td>
<td>(1) The one key; can be used in conjunction with SELECT NODE to jump to a particular node</td>
<td>(CLIP/FM) Switches the mode of motion tracking or keyframing of window shape and position in the tracking graph between Clip mode (where adjustments are made globally to the entire duration of a window) and Frame mode (where adjustments are made at specific frames, adding keyframes to the Tracker graph to animate a window)</td>
<td>(+KF) Adds a keyframe to the tracking graph, typically used while in Frame mode where keyframes are added while rotoscoping image movement with a window</td>
</tr>
<tr>
<td>2/TRACK REVERSE/COPY</td>
<td>(2) The two key; can be used in conjunction with SELECT NODE to jump to a particular node</td>
<td>(TRACK REVERSE) Initiates motion tracking in reverse for the currently selected window</td>
<td>(COPY) Copies track data from the currently selected window</td>
</tr>
<tr>
<td>3/TRACK FORWARD/PASTE</td>
<td>(3) The three key; can be used in conjunction with SELECT NODE to jump to a particular node</td>
<td>(TRACK FORWARD) Initiates motion tracking forward for the currently selected window</td>
<td>(PASTE) Copies track data to the currently selected window</td>
</tr>
<tr>
<td>–/STEP REVERSE/SHOW</td>
<td>–</td>
<td>(STEP REVERSE) Initiates window tracking in reverse by one frame and then stops, giving you time to evaluate the result</td>
<td>(SHOW) Toggles Show Track on and off; shows the motion path of the currently selected motion tracking data in the Viewer</td>
</tr>
<tr>
<td>4/STEP FORWARD/RESET</td>
<td>(4) The four key; can be used in conjunction with SELECT NODE to jump to a particular node</td>
<td>(STEP FORWARD) Initiates window tracking forward by one frame and then stops, giving you time to evaluate the result</td>
<td>(RESET) Resets all motion tracking in the Tracking graph</td>
</tr>
<tr>
<td>5/PREV TRK K/FM/DEL KF</td>
<td>(5) The five key; can be used in conjunction with SELECT NODE to jump to a particular node</td>
<td>(PREV TRK K/FM) Moves the playhead to the previous keyframe in the Tracker graph</td>
<td>(DEL KF) Deletes the keyframe at the position of the playhead in the Tracker graph</td>
</tr>
<tr>
<td>6/NEXT TRK K/FM/CL ALL</td>
<td>(6) The six key; can be used in conjunction with SELECT NODE to jump to a particular node</td>
<td>(NEXT TRK K/FM) Moves the playhead to the next keyframe in the Tracker graph</td>
<td>(CL ALL) Deletes all keyframes in the Tracker palette</td>
</tr>
<tr>
<td>Key</td>
<td>Shift Up</td>
<td>Primary Function</td>
<td>Shift Down</td>
</tr>
<tr>
<td>-----</td>
<td>----------</td>
<td>-----------------</td>
<td>-----------</td>
</tr>
<tr>
<td>AUTO/MODE/SEARCH</td>
<td>(AUTO) Performs an Auto Balance function in the Primaries palette</td>
<td>(MODE) Turns on the Modes soft menu on the Trackball panel, so you can choose different functions including OBJECT TRACKING, PROXY ON/OFF, POTS, RIPPLE mode, WIPE mode, SWITCH SESSION, SAFE AREA, CACHE mode, CUE mode, SCROLL mode, and 3D</td>
<td>(SEARCH) Not yet implemented at the time of this writing</td>
</tr>
<tr>
<td>7/STABILIZE/BYPASS</td>
<td>(7) The seven key; can be used in conjunction with SELECT NODE to jump to a particular node</td>
<td>(STABILIZE) Initiates image stabilization for the current clip, using the current settings in the Tracking palette’s Stabilizer mode</td>
<td>(BYPASS) Toggles image stabilization off and then on again, so you can compare the stabilized image to the original</td>
</tr>
<tr>
<td>8/DISABLE OFX/DEL</td>
<td>(8) The eight key; can be used in conjunction with SELECT NODE to jump to a particular node</td>
<td>(DISABLE OFX) Toggles OFX on and off if one has been applied to the current node</td>
<td>(DEL) Removes an OFX effect that’s been added to a node</td>
</tr>
<tr>
<td>9/DISABLE ALL/~</td>
<td>(9) The nine key; can be used in conjunction with SELECT NODE to jump to a particular node</td>
<td>(DISABLE ALL) Toggles all nodes for the current clip off and then on</td>
<td>—</td>
</tr>
<tr>
<td>SHIFT DOWN</td>
<td>—</td>
<td>(SHIFT DOWN) Enables use of any of the SHIFT DOWN key functions at the bottom of various keys</td>
<td>—</td>
</tr>
<tr>
<td>/*BYPASS FUSION/EXTRACT</td>
<td>(*) The Asterisk key</td>
<td>(BYPASS FUSION) Toggles all Fusion page effects off and then on for the current clip</td>
<td>(EXTRACT) Disconnects the selected node from the node graph, but leaves it in the Node Editor, ready to be reconnected somewhere else</td>
</tr>
<tr>
<td>0/BYPASS TRIMS/CLEAN UP</td>
<td>(0) The zero key; can be used in conjunction with SELECT NODE to jump to a particular node</td>
<td>(BYPASS TRIMS) Toggles all Color page effects off and then on for the current clip</td>
<td>(CLEAN UP) Cleans up unruly node graphs to be more ruly</td>
</tr>
<tr>
<td>#/BYPASS ALL/~</td>
<td>(#) The Hash key (or Pound sign)</td>
<td>(BYPASS ALL) Toggles both Color and Fusion page effects off and then on for the current clip</td>
<td>—</td>
</tr>
</tbody>
</table>
Node Control Group

This group of keys, at the bottom center of the T-bar panel, lets you quickly create the many different kinds of nodes that are available with which to organize your grades in the Node Editor of the Color page.

The DaVinci Resolve Color page is a node-based grading system, where the adjustments you make appear as nodes in the Node Editor. Each node contains one or more adjustments that work together. This is similar to the layers that appear in other applications, however nodes provide the flexibility to route image data nonlinearly within a grade, connecting the output of one node to the input of any other node farther down the tree of nodes, branching image processing operations or recombining them via parallel or serial layer nodes to combine Color page functions in creative ways to create sophisticated operations.

### Node Control Keys

The Node Control keys let you create a wide variety of nodes for grading.

<table>
<thead>
<tr>
<th>Key</th>
<th>Shift Up</th>
<th>Primary Function</th>
<th>Shift Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>+INPUT/ADD OUTSIDE/OFX ALPHA</td>
<td>(+INPUT) Lets you add inputs to any mixer node, including the Parallel Mixer, the Layer Mixer, and the Key Mixer</td>
<td>(ADD OUTSIDE) Adds a Corrector node in serial that connects both its RGB and KEY inputs to the outputs of the node before it, with the KEY input inverted, so you can make adjustments to parts of an image that are outside the preceding node’s qualified or windowed area.</td>
<td>(OFX ALPHA) Turns on “Use OFX Alpha” to enable the selected node to output whatever</td>
</tr>
<tr>
<td>SWAP/&gt;SHARED/KEY MIXER</td>
<td>(SWAP) Does “Morph into Layer Mixer Node” or “Morph into Parallel Mixer Node” if a relevant Mixer node is selected; Changes a Parallel Mixer into a Layer Mixer and vice versa</td>
<td>(&gt;SHARED) Turns the currently selected node into a Shared node; Shared nodes automatically ripple adjustments other grades that use the same Shared node.</td>
<td>(KEY MIXER) Adds a Key Mixer node with its first KEY input attached to the currently selected node’s KEY output; Key Mixer nodes let you combine multiple keys.</td>
</tr>
<tr>
<td>Key</td>
<td>Shift Up</td>
<td>Primary Function</td>
<td>Shift Down</td>
</tr>
<tr>
<td>-----</td>
<td>----------</td>
<td>-----------------</td>
<td>-----------</td>
</tr>
<tr>
<td>–/NODE+POLYGON/ +POLY</td>
<td>–</td>
<td>(NODE+POLYGON) Adds a Corrector node in serial with a polygon window automatically enabled for fast isolation; you can begin drawing a polygon immediately in the Viewer.</td>
<td>(+POLY) Turns on the polygon window for the currently selected node.</td>
</tr>
<tr>
<td>PRECLIP/CLIP/TL/ POSTCLIP</td>
<td>(PRECLIP) Opens the Pre-Clip group grade mode of the Node Editor; only works when a clip is part of a group</td>
<td>(CLIP/TL) Toggles between the Clip and Timeline grade modes of the Node Editor</td>
<td>(POSTCLIP) Opens the Post-Clip group grade mode of the Node Editor; only works when a clip is part of a group</td>
</tr>
<tr>
<td>NODE+CIRCLE/+CIRCLE</td>
<td>–</td>
<td>(NODE+CIRCLE) Adds a Corrector node in serial with a circular window automatically enabled for fast isolation</td>
<td>(+CIRCLE) Turns on the circular window for the currently selected node</td>
</tr>
<tr>
<td>NODE+LINEAR/+LINEAR</td>
<td>–</td>
<td>(NODE+LINEAR) Adds a Corrector node in serial with a linear window automatically enabled for fast isolation</td>
<td>(+LINEAR) Turns on the linear window for the currently selected node</td>
</tr>
<tr>
<td>NODE+CURVE/+CURVE</td>
<td>–</td>
<td>(NODE+CURVE) Adds a Corrector node in serial with a circular window automatically enabled for fast isolation. You can begin drawing a custom curve shape immediately in the Viewer.</td>
<td>(+CURVE) Turns on the curve window for the currently selected node</td>
</tr>
<tr>
<td>NODE+GRADIENT/ +GRAD</td>
<td>–</td>
<td>(NODE+GRADIENT) Adds a Corrector node in serial with a gradient window automatically enabled for fast isolation</td>
<td>(+GRAD) Turns on the gradient window for the currently selected node</td>
</tr>
<tr>
<td>–/APPEND CIRCLE/ LABEL</td>
<td>–</td>
<td>(APPEND CIRCLE) Appends a Corrector node in serial with a circular window enabled at the end of your node tree</td>
<td>(LABEL) Lets you type a label above the selected node to identify what it does</td>
</tr>
<tr>
<td>+SPLIT/APPEND LINEAR/–</td>
<td>(+SPLIT) Adds a Splitter node to your node tree, which splits the red, green, and blue image channels into separate outputs for separate processing</td>
<td>(APPEND LINEAR) Appends a Corrector node in serial with a linear window enabled at the end of your node tree</td>
<td>–</td>
</tr>
<tr>
<td>Key</td>
<td>Shift Up</td>
<td>Primary Function</td>
<td>Shift Down</td>
</tr>
<tr>
<td>-----</td>
<td>----------</td>
<td>------------------</td>
<td>------------</td>
</tr>
<tr>
<td>+COMB/APPEND CURVE/POLY</td>
<td>+COMB) Adds a Combiner node to your node tree, which combines red, green, and blue image channels that have been split back into a single image</td>
<td>(APPEND CURVE) Appends a Corrector node in serial with a Custom Curve window enabled at the end of your node tree. You can begin drawing a custom curve shape immediately in the Viewer.</td>
<td>(POLY) Appends a Corrector node in serial with a custom curve window enabled at the end of your node tree. You can begin drawing a polygon shape immediately in the Viewer.</td>
</tr>
<tr>
<td>APPEND GRADIENT</td>
<td>–</td>
<td>(APPEND GRADIENT) Appends a Corrector node in serial with a gradient window enabled at the end of your node tree</td>
<td>–</td>
</tr>
<tr>
<td>ADD SERIAL/+BEFORE</td>
<td>–</td>
<td>(ADD SERIAL) The most common way of adding Corrector nodes is in serial, where each new node’s input is connected to the previous node’s output, one after another. Adjustments in preceding nodes will be the starting point for subsequent nodes, so they all work together to combine different sets of adjustments in serial order, similar to layers in a layer-oriented system.</td>
<td>(+BEFORE) Adds a corrector node in serial prior to (before) the currently selected node</td>
</tr>
<tr>
<td>ADD PARALLEL/+FIRST</td>
<td>–</td>
<td>(ADD PARALLEL) Adds a Corrector node in parallel underneath the currently selected node, with both connected to a multi-input Parallel Mixer node (creating one if necessary) so that all input images are mixed together. Each node in parallel shares the same input image, so you can perform multiple operations to the same image and combine them back together.</td>
<td>(+FIRST) Adds a Corrector node before the currently selected parallel node, so that both nodes sit within the same parallel branch of the node tree, with the new node preceding the original one.</td>
</tr>
<tr>
<td>ADD LAYER</td>
<td>–</td>
<td>(ADD LAYER) Adds a Corrector node as a layer underneath the currently selected node, connected to a multi-input Layer Mixer node (creating one if necessary) so that its output has higher mix priority than any other nodes previously connected to the same Layer Mixer. The Layer Mixer node combines the outputs of multiple nodes such that the image output by lower nodes takes priority over images output by higher nodes. Layer Mixer nodes can also be set to use different composite modes to combine images together in different ways.</td>
<td>–</td>
</tr>
<tr>
<td>APPEND NODE</td>
<td>–</td>
<td>(APPEND NODE) Adds a corrector node serially to the very end of the node graph.</td>
<td>–</td>
</tr>
</tbody>
</table>
The T-Bar Control

The T-bar control is a vertical lever that you can push and pull up and down. Functioning as a fader, it’s mainly used to control the mix or wipe of a reference image against the current clip being evaluated.

Which reference is being compared, and the method of comparison, is controlled by the Viewer and Reference Group of fixed keys immediately below it.

Viewer and Reference Group

This area below the T-bar includes six keys that let you choose among different reference modes for the Viewer, different Viewer modes, and the Highlight mode. When an appropriate mode is active, the fader bar controls the mix or wipe position for that mode.

<table>
<thead>
<tr>
<th>Key</th>
<th>Shift Up</th>
<th>Primary Function</th>
<th>Shift Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>MENU/SPLIT SCREEN/CLEAN</td>
<td>(MENU) Press to show a row of Split Screen view options in the Trackball panel soft buttons, with which to compare multiple clips</td>
<td>(SPLIT SCREEN) Toggles a split screen comparison on and off, with which to compare multiple clips in different ways</td>
<td>(CLEAN) Toggles Video Clean Feed on and off (Workspace &gt; Video Clean Feed)</td>
</tr>
<tr>
<td>ENHANCED/FULL SCREEN/CINEMA</td>
<td>(ENHANCED) Sets the Viewer to Enhanced mode</td>
<td>(FULL SCREEN) Sets the Viewer to Full Screen mode</td>
<td>(CINEMA) Sets the Viewer to Cinema mode</td>
</tr>
</tbody>
</table>
### Key Shift Up Primary Function Shift Down

<table>
<thead>
<tr>
<th>Key</th>
<th>Shift Up</th>
<th>Primary Function</th>
<th>Shift Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>B&amp;W/HIGHLIGHT/DIFF</td>
<td>(B&amp;W) Toggles the Highlight between high-contrast Black and White mode and the regular gray modes</td>
<td>(HIGHLIGHT) Toggles the Highlight on and off; used to see the resulting matte when adjusting a Qualifier or Window isolation</td>
<td>(DIFF) Toggles the Highlight between Difference and the regular gray modes</td>
</tr>
<tr>
<td>GALLERY/REF INVERT/RGB</td>
<td>(GALLERY) Sets the currently selected clip in the gallery as the reference image</td>
<td>(REF INVERT) Inverts the left and right halves of the images being compared</td>
<td>(RGB) Shows an individual red, green, or blue channel in the Viewer; press SHIFT DOWN, then REF INVERT, then the 1 (labeled Green), 3 (labeled Blue), or 5 (labeled Red) buttons on the Search Dial panel. Press REF INVERT to go back to viewing RGB.</td>
</tr>
<tr>
<td>TIMELINE/REF STYLE/–</td>
<td>(TIMELINE) Lets you compare the current still in the Gallery to the Timeline image</td>
<td>(REF STYLE) Cycles among all the different split-screen wipe styles, so you can choose how to compare the current and reference images</td>
<td>–</td>
</tr>
<tr>
<td>OFFLINE/REF ON</td>
<td>(OFFLINE) Compares the current frame at the playhead to the currently assigned Offline Reference Movie frame at the same timecode</td>
<td>(REF ON) Toggles a Gallery wipe on and off, with which to compare a saved still to the current clip</td>
<td>–</td>
</tr>
</tbody>
</table>

### The Search Dial panel

The Search Dial panel, typically located on the right for a right-handed colorist, has an LCD display with four variable controls and nine soft keys. The lower section of the panel houses the Jog/Shuttle knob and six groups of hard keys. Each group and their keys are described below.

#### Memories Group

The first group of keys is the Memories group. These include the grade reset controls, buttons for storing and recalling memories (by letter), and controls for grabbing and browsing stills, applying grades, and controlling looping for playback.

The letter keys in this group are called “memories” or MEMs, which save stills and grades that you can quickly apply to another clip to overwrite its previous grade. There are 26 MEMs, labeled with letters from A to Z. To apply a MEM to another clip, simply press the letter corresponding to the MEM with the grade you want to apply. To save a grade to a MEM, press CRNT and then the letter of the MEM you want to save to. More information appears in the table of key functionality below.
The Memories keys let you save and recall memories for quick grade propagation, grade reset buttons, and other grade management functions.

<table>
<thead>
<tr>
<th>Key</th>
<th>Shift Up</th>
<th>Primary Function</th>
<th>Shift Down</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ALL/RESET NODE/GRADES</strong></td>
<td>(ALL) Reset All Grades and Nodes; resets the entire grade of the current clip back to the default of one unadjusted node</td>
<td>(RESET NODE) Reset Selected Node Grade; resets all adjustments that have been made to the currently selected node</td>
<td>(GRADES) Reset Grades and Keep Nodes; resets each node of the current clip’s grade but keeps the node structure intact</td>
</tr>
<tr>
<td>Q/A/I</td>
<td>(Q) Loads or saves memory Q</td>
<td>(A) Loads or saves memory A</td>
<td>(I) Loads or saves memory I</td>
</tr>
<tr>
<td>R/B/J</td>
<td>(R) Loads or saves memory R</td>
<td>(B) Loads or saves memory B</td>
<td>(J) Loads or saves memory J</td>
</tr>
<tr>
<td>S/C/K</td>
<td>(S) Loads or saves memory S</td>
<td>(C) Loads or saves memory C</td>
<td>(K) Loads or saves memory K</td>
</tr>
<tr>
<td>Key</td>
<td>Shift Up</td>
<td>Primary Function</td>
<td>Shift Down</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------</td>
<td>------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>T/D/L</td>
<td>(T) Loads or saves memory T</td>
<td>(D) Loads or saves memory D</td>
<td>(L) Loads or saves memory L</td>
</tr>
<tr>
<td>CRNT</td>
<td>–</td>
<td>(CRNT) Press CRNT and then any letter key to save the image and grade at the current frame to that memory for recall</td>
<td>–</td>
</tr>
<tr>
<td>INFO/DISPLAY GRAPH/MEMS</td>
<td>(INFO) Toggles the Still Properties window open and closed; the Still Properties window shows information about the currently selected still in the Gallery</td>
<td>(DISPLAY GRAPH) Displays the node graph of the selected still in the Gallery (only while the Gallery is open) or hides a displayed node graph</td>
<td>(MEMS) Toggles open and closed the memories section of the Gallery</td>
</tr>
<tr>
<td>U/E/M</td>
<td>(U) Loads or saves memory U</td>
<td>(E) Loads or saves memory E</td>
<td>(M) Loads or saves memory M</td>
</tr>
<tr>
<td>V/F/N</td>
<td>(V) Loads or saves memory V</td>
<td>(F) Loads or saves memory F</td>
<td>(N) Loads or saves memory N</td>
</tr>
<tr>
<td>W/G/O</td>
<td>(W) Load or save memory W</td>
<td>(G) Loads or saves memory G</td>
<td>(O) Loads or saves memory O</td>
</tr>
<tr>
<td>X/H/P</td>
<td>(X) Loads or saves memory X</td>
<td>(H) Loads or saves memory H</td>
<td>(P) Loads or saves memory P</td>
</tr>
<tr>
<td>+POWER/+PAGE/LABEL</td>
<td>(+POWER) Adds another Power Grade album to the Gallery</td>
<td>(+PAGE) Adds another project album to the Gallery</td>
<td>(LABEL) Selects the name of the currently selected album of the Gallery so you can change it</td>
</tr>
<tr>
<td>INSERT/APPLY GRADE/LABEL</td>
<td>(INSERT) Not yet implemented at the time of this writing</td>
<td>(APPLY GRADE) Applies the grade of the selected still in the Gallery to overwrite the grade of the current clip</td>
<td>(LABEL) Selects the label of the selected still in the Gallery so you can add one or change it</td>
</tr>
<tr>
<td>Key</td>
<td>Shift Up</td>
<td>Primary Function</td>
<td>Shift Down</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>APPEND GRADE/DEL</td>
<td>–</td>
<td>(APPEND GRADE) Appends all nodes from the grade of the selected still in the Gallery after the last node of the grade of the current clip</td>
<td>(DEL) Deletes the selected still in the Gallery</td>
</tr>
<tr>
<td>-2/PREV PAGE/MATCH FM</td>
<td>(~2) Copies grade from two clips before the current clip to overwrite the grade in the current clip</td>
<td>(PREV PAGE) Selects the previous Album in the Album list of the Gallery</td>
<td>(MATCH FM) Performs a Match Frame operation that moves the playhead to the frame of the Timeline that matches the currently selected still in the Gallery</td>
</tr>
<tr>
<td>-1/NEXT PAGE</td>
<td>(~1) Copies grade from the clip just before the current clip to overwrite the grade in the current clip</td>
<td>(NEXT PAGE) Selects the next Album in the Album list of the Gallery</td>
<td>–</td>
</tr>
<tr>
<td>NONE/USE SRC TC/START FM</td>
<td>(NONE) Changes the “Apply Grades Using” option in the Gallery to No Keyframes</td>
<td>(USE SRC TC) Changes the “Apply Grades Using” option in the Gallery to Keyframes Aligning Source Timecode</td>
<td>(START FM) Changes the “Apply Grades Using” option in the Gallery to Keyframes Aligning Start Frames</td>
</tr>
<tr>
<td>GROUP/rippel SEL/APPEND</td>
<td>(GROUP) Ripple Node Changes to Group, when you select a clip that’s part of a group and make a change to one node, that change is rippled to the same node of every clip in the group</td>
<td>(rippel SEL) Ripple Node Changes to Selected Clips, when you select multiple clips and make a change to one node, that change is rippled to the same node of every selected clip</td>
<td>(APPEND) Append Node to Selected Clips, when you select multiple clips and make a change to a new node, that node is appended to the end of the grade of every selected clip</td>
</tr>
<tr>
<td>MISSING/GRAB STILL/MIDDLE</td>
<td>(MISSING) Saves a still for every clip in the timeline that does not already have a still in the currently selected Album of the Gallery</td>
<td>(GRAB STILL) Saves the currently displayed still in the Viewer, and its grade, to the currently selected Album of the Gallery</td>
<td>(MIDDLE) Saves one still for every clip in the timeline at the middle of each clip</td>
</tr>
<tr>
<td>P/PONG/LOOP/PLAYHEAD</td>
<td>(P/PONG) Toggles looping mode between ping-pong and loop forward</td>
<td>(LOOP) Toggles playback looping on and off</td>
<td>(PLAYHEAD) Press to add an Active Playhead to the Mini Timeline using the highlighted A/B/C/D keys above; once added, pressing PLAYHEAD and a letter switches playback control to that playhead</td>
</tr>
</tbody>
</table>
– **Duration**: To define a duration, first select the time using the numerical keypad (the colon separates the hours, minutes, seconds, and frames), and then select Duration.

– **Cue**: Selecting Cue will force the transport to the preroll position.

### Management and Modes Group

This group of keys gives access to a wide variety of functions that, due to their diversity, are difficult to generalize. They include everything from the all-important Undo and Redo commands, to splitting and rejoining clips, setting and clearing In and Out points to control playback and looping, and commands for reverting to the Original Memory, using Preview Memory, and using Scroll (which is described in more detail later in this chapter).

#### The Management and Modes Keys

The Management and Modes keys provide Undo/Redo, range, Flag and Marker, printer lights, and grade management functionality.

<table>
<thead>
<tr>
<th>Key</th>
<th>Shift Up</th>
<th>Primary Function</th>
<th>Shift Down</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SCENE/UNDO/NEXT CLIP</strong></td>
<td>(SCENE) Opens the Scene Detect Window</td>
<td>(UNDO) Triggers one step of undo; DaVinci Resolve supports unlimited steps of undo</td>
<td>(NEXT CLIP) Not yet implemented at the time of this writing</td>
</tr>
<tr>
<td><strong>SPLIT/REDO/JOIN</strong></td>
<td>(SPLIT) Splits one clip into two at the frame under the playhead, so each split clip can be graded independently</td>
<td>(REDO) Triggers one step of redo; DaVinci Resolve supports unlimited steps of undo</td>
<td>(JOIN) The reverse of the Split key; move the playhead to an edit point with contiguous timecode, and press JOIN to merge the clips into one.</td>
</tr>
<tr>
<td>Key</td>
<td>Shift Up</td>
<td>Primary Function</td>
<td>Shift Down</td>
</tr>
<tr>
<td>-----</td>
<td>----------</td>
<td>------------------</td>
<td>------------</td>
</tr>
<tr>
<td>IN/CLEAR I</td>
<td>–</td>
<td>(IN) Sets a timeline In point to use when looping playback</td>
<td>(CLEAR I) Clears the timeline In point</td>
</tr>
<tr>
<td>DUR/OUT/CLEAR O</td>
<td>(DUR) If you’ve set In and Out points, this key lets you create a marker with duration.</td>
<td>(OUT) Sets a timeline Out point to use when looping playback</td>
<td>(CLEAR O) Clears the timeline Out point</td>
</tr>
<tr>
<td>SHOW/FLAG/CLIP</td>
<td>(SHOW) Press to show a row of flag colors in the Trackball panel soft buttons with which to filter the Thumbnail Timeline by. &lt; and &gt; buttons let you page among all 16 colors, and EXIT lets you finish. Press SHOW ALL CLIPS in the soft menu to stop filtering.</td>
<td>(FLAG) Press to show a row of colors with which to flag the current clip in the Trackball panel soft buttons. &lt; and &gt; buttons let you page among all 16 colors, and EXIT lets you finish.</td>
<td>*(CLIP) Press to show a row of colors with which to color code the current clip in the Trackball panel soft buttons.</td>
</tr>
<tr>
<td>SHOW/MARKER/NODE</td>
<td>(SHOW) Press to show a row of marker colors in the Trackball panel soft buttons with which to filter the Thumbnail Timeline by. &lt; and &gt; buttons let you page among all 16 colors, and EXIT lets you finish. Press SHOW ALL CLIPS in the soft menu to stop filtering.</td>
<td>(MARKER) Press to show a row of colors with which to mark the current frame in the Trackball panel soft buttons. &lt; and &gt; buttons let you page among all 16 colors, and EXIT lets you finish.</td>
<td>(NODE) Press to show a row of colors with which to color code the current node in the Node Editor using the Trackball panel soft buttons. &lt; and &gt; buttons let you page among all 16 colors, and EXIT lets you finish.</td>
</tr>
<tr>
<td>1/2/P/LITE/1/4</td>
<td>(1/2) Sets printer points adjustments to be made in “half-point” increments</td>
<td>(P/LITE) Toggles “Printer Lights” on or off. When on, the Jog/Shuttle panel’s number keys are used to make printer point adjustments in “whole points” increments (shown on each number key’s “shift up” position). This key remains highlighted while P/LITE is on.</td>
<td>(1/4) Sets printer points adjustments to be made in “quarter-point” increments</td>
</tr>
<tr>
<td>FLAG/DELETE/MARKER</td>
<td>(FLAG) Deletes all flags on the current clip</td>
<td>(DELETE) Deletes the currently selected node in the Node Editor</td>
<td>(MARKER) Deletes any marker at the position of the playhead</td>
</tr>
<tr>
<td>Key</td>
<td>Shift Up</td>
<td>Primary Function</td>
<td>Shift Down</td>
</tr>
<tr>
<td>-----</td>
<td>----------</td>
<td>------------------</td>
<td>------------</td>
</tr>
<tr>
<td><strong>ORIG MEM</strong></td>
<td>–</td>
<td>(ORIG MEM) If you select a graded clip, then change the grade and decide you don’t like the change, press ORIG MEM to return to original state (or memory) of that clip when you first selected it.</td>
<td>–</td>
</tr>
<tr>
<td><strong>PVW MEM</strong></td>
<td>–</td>
<td>(PVW MEM) To preview how a saved memory looks when applied to the current clip, press PVW MEM and then any memory key. If you don’t like the result, press PVW MEM again to toggle the grade to how it was before.</td>
<td>–</td>
</tr>
<tr>
<td><strong>SCROLL</strong></td>
<td>–</td>
<td>(SCROLL) The Scroll key opens a row of controls on the Trackball panel soft buttons that lets you preview how grades on neighboring clips would look on the current clip, with the option to then copy a grade (EXIT AS IS) or cancel without doing anything (EXIT AS WAS).</td>
<td>–</td>
</tr>
<tr>
<td><strong>SAME/SELECT NODE/ LAST ADJ</strong></td>
<td>(SAME) Changes the “Switching Clips Selects” option to “Same Node” so that moving to another clip selects the same node in the Node Editor that was selected in the previous clip</td>
<td>(SELECT NODE) Press after typing a node number to change the currently selected node</td>
<td>(LAST ADJ) Changes the “Switching Clips Selects” option to “Last Adjusted Node” so that moving to another clip selects whichever node in the Node Editor was previously adjusted for that clip</td>
</tr>
</tbody>
</table>

**Jog/Shuttle Control**

The Jog/Shuttle control is actually two controls in one. The Shuttle control is the outer knob, which rocks to the left and right and controls real-time or fast playback. The Jog control is an inner wheel that spins freely and controls the playhead in slow motion, a frame or two at a time.

- **Shuttle:** The Shuttle control is the outer knob, which rocks to the left and right. This knob has a detent at the center position which stops playback. Turning this control counter-clockwise shuttles among a variety of reverse speeds, with reverse playback going faster the farther left you turn. Turning this control clockwise shuttles among a variety of forward speeds, with playback going faster the farther right you turn.

- **Jog:** The Jog control is an inner wheel that spins freely. Rotate the Jog control to step forward or backward a few frames at a time.
The Jog/Shuttle control lets you control playback and playhead position. The Transport Control keys let you control playback, navigate stills in galleries, and navigate nodes in the Node Editor.

Transport Control Keys Group
This group of keys is found beneath the Jog/Shuttle control. These keys are all about controlling playback and moving the playhead around your timeline.

<table>
<thead>
<tr>
<th>Key</th>
<th>Shift Up</th>
<th>Primary Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHIFT UP</td>
<td></td>
<td>(SHIFT UP) Enables use of any of the SHIFT UP key functions at the top of various keys</td>
</tr>
<tr>
<td>SHIFT DOWN</td>
<td></td>
<td>(SHIFT DOWN) Enables use of any of the SHIFT DOWN key functions at the bottom of various keys</td>
</tr>
<tr>
<td>FLAG/PREV STILL</td>
<td>(FLAG) Go to previous flagged still; not yet implemented at the time of this writing</td>
<td>(PREV STILL) Selects the previous still in the currently selected Album of the Gallery</td>
</tr>
<tr>
<td>FLAG/NEXT STILL</td>
<td>(FLAG) Go to next flagged still; not yet implemented at the time of this writing</td>
<td>(NEXT STILL) Selects the next still in the currently selected Album of the Gallery, for use with the REF ON or SPLIT SCREEN keys</td>
</tr>
<tr>
<td>Key</td>
<td>Shift Up</td>
<td>Primary Function</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CUE/FIRST FRAME</td>
<td>(CUE) Go to first frame of pre-roll; not yet implemented at the time of this writing</td>
<td>(FIRST FRAME) Selects the first frame of the current clip</td>
</tr>
<tr>
<td>CUE/LAST FRAME</td>
<td>(CUE) Go to last frame of pre-roll; not yet implemented at the time of this writing</td>
<td>(LAST FRAME) Selects the last frame of the current clip</td>
</tr>
<tr>
<td>FIRST/PREV NODE</td>
<td>(FIRST) Selects the first node in the Node Editor</td>
<td>(PREV NODE) Selects the previously numbered node in the Node Editor</td>
</tr>
<tr>
<td>LAST/NEXT NODE</td>
<td>(LAST) Selects the last node in the Node Editor</td>
<td>(NEXT NODE) Selects the next numbered node in the Node Editor</td>
</tr>
<tr>
<td>MARKER/PREV FRAME</td>
<td>(MARKER) Moves the playhead back to the last previous marker</td>
<td>(PREV FRAME) Moves the playhead backward a single frame in the Timeline</td>
</tr>
<tr>
<td>MARKER/NEXT FRAME</td>
<td>(MARKER) Moves the playhead forward to the next existing marker</td>
<td>(NEXT FRAME) Moves the playhead forward a single frame in the Timeline</td>
</tr>
<tr>
<td>START/PREV CLIP</td>
<td>(START) Moves the playhead to the first frame of the current clip</td>
<td>(PREV CLIP) Selects the first frame of the previous clip</td>
</tr>
<tr>
<td>END/NEXT CLIP</td>
<td>(END) Moves the playhead to the last frame of the current clip</td>
<td>(NEXT CLIP) Selects the first frame of the next clip</td>
</tr>
<tr>
<td>FAST REVERSE</td>
<td>–</td>
<td>(FAST REVERSE) Shuttles backward along the Timeline at fast speed; pressing multiple times increases speed.</td>
</tr>
<tr>
<td>SLOW/REVERSE</td>
<td>(SLOW) Plays in slow motion reverse (Edit page only)</td>
<td>(REVERSE) Plays the Clip/Timeline in reverse at 100%.</td>
</tr>
</tbody>
</table>
### Numeric Entry Group

On the center right-hand side of the Search Dial panel is the Numerical Entry key group. Here you will find numbers 0 to 9 and associated keys for entering timecode and clip numbers. You will notice the numbers you type are displayed in a scratchpad area at the bottom of the Keyframe palette.

<table>
<thead>
<tr>
<th>Key</th>
<th>Shift Up</th>
<th>Primary Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>REVIEW/STOP</td>
<td>(REVIEW) Initiates Review playback; not yet implemented at the time of this writing</td>
<td>(STOP) Stops the current transport operation</td>
</tr>
<tr>
<td>SLOW/FORWARD</td>
<td>(SLOW) Plays in slow motion forward (Edit page only)</td>
<td>(FORWARD) Plays the Clip/Timeline forward at 100% speed</td>
</tr>
<tr>
<td>FAST FORWARD</td>
<td>–</td>
<td>(FAST FORWARD) Shuttles forward along the Timeline at fast speed; pressing multiple times increases speed.</td>
</tr>
</tbody>
</table>

The number keys group provides access to multiple overlapping functions, including Printer Points adjustment when the P/LITE mode is enabled.
<table>
<thead>
<tr>
<th>Key</th>
<th>Shift Up</th>
<th>Primary Function</th>
<th>Shift Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>+R/NUM LK</td>
<td>+R (Plus Red in P/LITE mode)</td>
<td>(NUM LK) Locks these keys to their numeric functions, useful for entering timecode for navigation</td>
<td>–</td>
</tr>
<tr>
<td>+G/ /</td>
<td>+G (Plus Green in P/LITE mode)</td>
<td>(/) The Forward Slash key</td>
<td>–</td>
</tr>
<tr>
<td>+B/ *</td>
<td>+B (Plus Blue in P/LITE mode)</td>
<td>(*) The Asterisk key</td>
<td>–</td>
</tr>
<tr>
<td>+MASTER/BACKSPACE</td>
<td>+MASTER (Plus Master RGB in P/LITE mode)</td>
<td>(BACKSPACE) Moves the text or numeric cursor one character left so you can correct numeric entries</td>
<td>–</td>
</tr>
<tr>
<td>–R/7/CHR LT</td>
<td>–R (Minus Red in P/LITE mode)</td>
<td>(7) The seven key</td>
<td>(CHR LT) Loads the Chroma Light Qualifier preset</td>
</tr>
<tr>
<td>–G/8/CHR DK</td>
<td>–G (Minus Green in P/LITE mode)</td>
<td>(8) The eight key</td>
<td>(CHR DK) Loads the Chroma Dark Qualifier preset</td>
</tr>
<tr>
<td>–B/9/LT DARK</td>
<td>–B (Minus Blue in P/LITE mode)</td>
<td>(9) The nine key</td>
<td>(LT DARK) Loads the Chroma Light and Dark Qualifier preset</td>
</tr>
<tr>
<td>–MASTER/’</td>
<td>–MASTER (Minus Master RGB in P/LITE mode)</td>
<td>(’) The Apostrophe. When pressed by itself, copies the grade from one clip to the left to the current clip</td>
<td>–</td>
</tr>
<tr>
<td>+C/4/MAGENTA</td>
<td>+C (Plus Cyan or Green+Blue in P/LITE mode)</td>
<td>(4) The four key</td>
<td>(MAGENTA) Loads the Magenta Qualifier preset</td>
</tr>
<tr>
<td>+M/5/BLUE</td>
<td>+M (Plus Magenta or Red+Blue in P/LITE mode)</td>
<td>(5) The five key</td>
<td>(BLUE) Loads the Blue Qualifier preset</td>
</tr>
<tr>
<td>Key</td>
<td>Shift Up</td>
<td>Primary Function</td>
<td>Shift Down</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>+Y/6/CYAN</td>
<td>+Y (Plus Yellow or Red+Green in P/LITE mode)</td>
<td>(6) The six key</td>
<td>(CYAN) Loads the Cyan Qualifier preset</td>
</tr>
<tr>
<td>:</td>
<td></td>
<td>() The Apostrophe key. When pressed by itself, copies the grade from two clips to the left to the current clip. When used after typing numbers, delineates timecode number positions (hr:min:sec:frm).</td>
<td></td>
</tr>
<tr>
<td>–C/1/GREEN</td>
<td>–C (Minus Cyan or Green+Blue in P/LITE mode)</td>
<td>(1) The one key</td>
<td>(GREEN) Loads the Green Qualifier preset</td>
</tr>
<tr>
<td>–M/2/YELLOW</td>
<td>–M (Minus Magenta or Red+Blue in P/LITE mode)</td>
<td>(2) The two key</td>
<td>(YELLOW) Loads the Yellow Qualifier preset</td>
</tr>
<tr>
<td>–Y/3/RED</td>
<td>–Y (Minus Yellow or Red+Green in P/LITE mode)</td>
<td>(3) The three key</td>
<td>(RED) Loads the Red Qualifier preset</td>
</tr>
<tr>
<td>CLOSE/CLEAR</td>
<td>(SHIFT UP CLOSE)</td>
<td>(CLEAR) Clears all numbers you were typing in case of mistakes</td>
<td></td>
</tr>
<tr>
<td>+</td>
<td></td>
<td>(+) The Plus key, use for entering relative timecode, such as +10 to move the playhead forward 10 frames</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td></td>
<td>(0) The zero key</td>
<td></td>
</tr>
<tr>
<td>–</td>
<td></td>
<td>(–) The Minus key, use for entering relative timecode, such as –10 to move the playhead backward 10 frames</td>
<td></td>
</tr>
</tbody>
</table>
Keyframing Group

The Keyframe keys are on the bottom right-hand side of the Search Dial panel. The functions are replicated on the T-bar panel. On the bottom right of the Color page is the Keyframe timeline for the current clip in the Timeline. The Keyframe group of keys is used in association with the Keyframe timeline and controls the selection of keyframes for the start and end of dynamic transitions of the grade.

<table>
<thead>
<tr>
<th>Key</th>
<th>Shift Up</th>
<th>Primary Function</th>
<th>Shift Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENTER</td>
<td>–</td>
<td>(ENTER) The Enter key, use after you’ve typed a timecode value to execute moving the playhead</td>
<td>–</td>
</tr>
</tbody>
</table>

The number keys group provides access to multiple overlapping functions, including Printer Points adjustment when the P/LITE mode is enabled.

<table>
<thead>
<tr>
<th>Key</th>
<th>Shift Up</th>
<th>Primary Function</th>
<th>Shift Down</th>
</tr>
</thead>
<tbody>
<tr>
<td>~/RIPPLE VALUE/ APPEND</td>
<td>–</td>
<td>(RIPPLE VALUE) Lets you ripple a change made to the currently selected node to the same node within a specified range of clips; for more information see “Rippling Changes Using the Advanced Control Panel” later in this chapter</td>
<td>(APPEND) Lets you ripple a change made to the currently selected node as an appended node to a specified range of clips; for more information see “Rippling Changes Using the Advanced Control Panel” later in this chapter</td>
</tr>
</tbody>
</table>
Auto Color Using the DaVinci Resolve Advanced Control Panel

To make an automatic correction to a clip, you can simply press SHIFT UP and then AUTO/MODE/SEARCH on the T-bar panel. This will use the advanced algorithms of the DaVinci Neural Engine to automatically analyze the image and adjust color balance and contrast to produce a nice, neutral starting point.

However, if you crave a bit more control over how the automatic color adjustment is made, and you have a DaVinci control panel, you can use the cursor to choose which color values to sample when making an automatic color balancing and contrast adjustment. It’s like a cross between the Auto Color control and the White and Black Point controls found in the GUI. This additional bit of guidance can make the results a lot more predictable.

To use Auto Grade to sample a feature using the DaVinci control panel:

1. Press the CURSOR button on the Trackball panel.
2. Use the fourth trackball to move the cursor to a feature you want to use to define the automatic correction. Whichever color you move the cursor over will be sampled to form the basis of the...
resulting color and contrast adjustment. Ideally, you should place the cursor over a feature that’s supposed to be neutral, such as a black shadow, gray wall, or white T-shirt. Don’t place the cursor over a feature that actually consists of saturated color, or that happens to be overexposed, as DaVinci Resolve will overcompensate and you’ll get poor results.

3 With the cursor placed over the desired neutral feature, press SHIFT UP and AUTO/MODE/SEARCH on the T-bar panel.

DaVinci Resolve calculates an appropriate correction, which is applied to the selected node.

**Legacy Auto Color**

The previous methods for doing Auto Color and Shot Match are available from the Color panel of the User Preferences, via two checkboxes named “Use Legacy Auto Color/Shot Match.” With these enabled, DaVinci Resolve looks for the darkest levels in the image to neutralize the RGB color balance in the blacks, and the brightest levels to neutralize the RGB color balance in the highlights. Furthermore, Master Lift and Master Gain are adjusted to maximize image contrast at the outer boundaries of 0 and 100 percent. Using this control with the Primaries Bars mode open makes it easier to see what’s been changed after these automatic adjustments are made.

**Adjusting Curves using the DaVinci Resolve Advanced Control Panel**

The DaVinci Resolve Advanced Panel can be used to adjust curves in many different ways, keeping your hands on the control panel for fast and efficient adjustment.

**Custom Curves Adjustments**

The controls that correspond to the Custom curves on the DaVinci control panel are available when you press the CURVES button on the Trackball panel. They’re also the default mapping of the right-hand side Search Dial panel soft menu.

**To open the Primary Curve controls of the DaVinci Resolve Advanced control panel:**

– Press the CURVES soft key on the Trackball panel.

The rotary knobs on the Center panel update to show the 0% LUM, 20% LUM, 40% LUM, 60% LUM, 80% LUM, and 100% LUM rotary knobs. These controls correspond to the following default control point positions on the Curve controls.

![Graph](image_url)
By default, all adjustments you make using these controls are ganged across all four YRGB curve controls. However, if you turn Custom curve ganging off by pressing the GANG soft key, then these controls only affect the curve you select using the LUM CURVE, RED CURVE, GREEN CURVE, and BLUE CURVE soft keys.

You also have the option of using the fourth trackball from the left to adjust individual control points on curves to any position you like. This works for all curves in DaVinci Resolve that have control surface mappings.

**Methods of selecting and adjusting curve points using the fourth trackball:**

1. Press **SHIFT DOWN** and **LEVEL/CURSOR/CURVE**.
2. Do one of the following to make adjustments:
   - **To select a control point to adjust:** Spin the fourth ring control to the left or right to select the next control point in that direction (it takes about half of a turn to select another control point). Selected control points are highlighted in cyan.
   - **To move a selected control point:** Adjust the fourth trackball to move the control point up, down, left, or right. Selected control points are constrained between whichever control points are to the left and right.

**To adjust the Curve Intensity sliders:**

- Adjust the **MASTER INTENSITY**, **RED INTENSITY**, **GREEN INTENSITY**, or **BLUE INTENSITY** soft knobs.

**To make YSFX adjustments:**

1. Press the **SOFT CLIP** soft key.
2. Adjust the **LUM YSFX**, **RED YSFX**, **GREEN YSFX**, or **BLUE YSFX** soft knobs.

**Soft Clipping Adjustments**
The soft clipping controls can also be manipulated using the DaVinci Resolve Advanced control panel, which provides separate controls for ganged and individual color channels.

**To open the soft clipping control on the DaVinci Resolve Advanced control panel:**

- Press the **CURVES** key on the Trackball panel, then press the **SOFT CLIP** soft key.

**To exit the soft clipping controls:**

- Press the **MAIN** soft key on the Center panel.

**To make a ganged soft clipping adjustment:**

- Adjust the **MASTER CLIP** or **MASTER SOFT** soft knobs of the SCENE BLACK CLIPS or SCENE WHITE CLIPS control groups.
- These controls adjust all four corresponding Master-RGB High Soft, High Clip, Low Soft, or Low Clip parameters simultaneously.

**To adjust soft clipping for individual color channels:**

- Adjust the **MASTER/RED/GREEN/BLUE CLIP** or **MASTER/RED/GREEN/BLUE SOFT** rotary knobs of the SCENE WHITE CLIPS or SCENE BLACK CLIPS control groups (there are 12 individual knobs).

**HSL Curves Controls**
The HSL curves can also be adjusted using the DaVinci Resolve Advanced Panel.
To open the soft clipping control on the DaVinci Resolve Advanced Panel:

1. Press the CURVES key on the Trackball panel.
2. Press the CURVES soft key on the soft menu.
3. Press the soft key that corresponds to the HSL curve you want to adjust, HUE•HUE, HUE•SAT, HUE•LUM, LUM•SAT, SAT•SAT, SAT•LUM.
4. Use the RED, YELLOW, GREEN, CYAN, BLUE, and MAGENTA, or the LOW, LOW-MID, MID-HIGH, and HIGH soft knobs to adjust the particular slice of hue or image tonality you want, using the method you’ve selected.

The Advanced Panel Number Pad Does Many Things

The number keys serve a wide number of uses. This section describes them all in one place.

Navigating Clips by Clip Number

You can move the playhead to the first frame of any clip in the Timeline by typing that clip’s number (listed above the upper left-hand corner of each thumbnail in the Thumbnail Timeline) using the number keys, and then pressing ENTER.

Navigating Clips by Timecode

To type timecode instead of a clip number, you need to add colons to signify that you’re entering hours followed by a colon, then the minutes followed by a colon, the seconds with a colon, and finally the frames followed by the ENTER key. As you enter timecode on the Color page, the timecode values you type appear in the lower right-hand corner of the DaVinci Resolve window, to the left of the Project Manager and Project Settings buttons.

DaVinci Resolve does not need to have leading numbers entered where they offer no value and the default value is 0, so to type one hour, three minutes, zero seconds, and sixteen frames, you do not need to type 01:03:00:16. Simply type 1:3::16 and then press Enter. This speeds timecode entry.

Moving the Playhead Using Relative Frame Numbers

If you type a + or – and a number of frames, the playhead will move forward or backward by that number of frames relative to its prior position.

Selecting Specific Nodes in the Node Editor

You can select specific nodes in the current node tree by typing the node’s number and then pressing SELECT NODE.

Making Printer Points Adjustments

You can use the number keys to make controlled Printer Points adjustments by pressing the P/LITE button (found in the group of keys just above the number keys). The P/LITE button remains highlighted as long as printer points adjustment using the number keys is active. Press P/LITE again to toggle printer points mode off.

The P/LITE button toggles printer points mode on and off in the default “whole point” mode. You can also press SHIFT UP P/LITE 1/2 to work in “half point” mode, or SHIFT DOWN P/LITE 1/4 to work in “quarter point” mode.

In Printer Points mode, you have three sets of controls:

– Plus and minus Red, Green, and Blue to adjust color balance in the additive manner, by raising or lowering specific color channels
– Plus and minus Master to raise or lower RGB equally to adjust luminance
– Plus and minus Cyan, Magenta, and Yellow to adjust color balance in the subtractive manner, by raising or lowering pairs of color channels corresponding to Cyan (Blue and Green), Magenta (Red and Blue), and Yellow (Red and Green)
Viewing Individual Red, Green, and Blue Channels in the Viewer

You can use the number keys to choose individual channels to evaluate in the Viewer, in order to more closely evaluate noise or image quality on a per-channel basis.

First, press SHIFT DOWN, then press the GALLERY/REF INVERT/RGB button on the T-bar panel to trigger the RGB function. Three number keys are then highlighted, 1 (labeled GREEN), 3 (labeled BLUE), AND 5 (labeled RED). Pressing any of these keys sets the Viewer to show only that channel as a grayscale image.

To go back to viewing full-color RGB, press REF INVERT.

Adding Tracking Points in Interactive Mode

The DaVinci Resolve Advanced control panel has a full set of tracking controls. However, there’s also the ability to manually add tracking points one by one while in Interactive Object Tracking mode.

To add a single tracking point:

1. Select a window you want to track.
2. Press SHIFT DOWN and ALL/WINDOW/TRACKER.
3. Press the INTERACTIVE soft key.
4. Using the DaVinci Resolve Advanced control panel, press the CURSOR button above the fourth trackball of the Center panel, and move the onscreen cursor to the detail of the image that you want to add a tracking point to.
5. Click the SET TRACK POINT soft key, within the Interactive mode controls of the Tracker palette.

This adds a tracking point corresponding to the feature of the image that you clicked, and you’re ready to start tracking.

Copying Grades Using the Advanced Control Panel

There are a number of procedures for copying grades that have specific implementations on the Advanced control panel.

Copy Forward Keys

The simplest way of copying grades using the control panel is to use the comma and colon keys on the keypad of the Search Dial panel, or the –1 and –2 SHIFT UP functions on the memory keys area of the Search Dial panel, to copy grades from one or two clips behind the currently selected clip. This is a great way to copy grades in scenes with a shot-reverse-shot structure, where you're cutting between two angles of coverage, each of which uses the same grade.

- **To copy a grade from one clip back:** Press the Comma (,) or –1 buttons.
- **To copy a grade from two clips back:** Press Colon (:) or –2 buttons.

Scroll

Scroll mode lets you quickly preview how different grades on a variety of other clips in the Timeline would look on the currently selected clip. As you preview the grade of each other clip, you have the option to either accept or reject the previewed grade to which you’ve “scrolled.” Accepted grades (EXIT AS IS) overwrite the previous grade of the current clip, while rejecting the scrolled grade (EXIT AS WAS) cancels the entire operation.

Scroll mode can be useful for checking to see if any of the previous grades you’ve created in a scene will work for the currently selected clip.
To use the Scroll mode:

1. Move the playhead to the clip to which you potentially want to copy a new grade. You can use the PREV SCENE and NEXT SCENE buttons to move around neighboring clips, or you can use the number keys to jump to a specific clip number or timecode value of the Timeline.

2. Do one of the following to enter Scroll mode:
   - Press SCROLL on the Search Dial panel.
   - Press MODE on the T-bar panel, then press the SCROLL MODE soft key.
   - Once you’re in Scroll mode, the Center panel soft menu displays a row of commands with which to control scrolling through previews of possible grades to copy.

3. Now, do one of the following to preview different grades from other clips:
   - Press the PREVIOUS SCENE and NEXT SCENE soft keys to move from clip to clip in the Timeline, previewing each grade to the current clip.
   - Turn the SCROLL SCENES knob to scroll smoothly along multiple clips in the Timeline.
   - Turn the SCROLL FRAMES knob to scroll along different frames of any clip, previewing the effects of keyframed grades at different points in time.
   - Press the TOGGLE DECK KEYS soft key to use the transport controls on the Search Dial panel to play through the Timeline, previewing grades as you go.
   - Enter a number on the keypad of the Search Dial panel, and then the SCENE # soft key, to jump to a clip and preview its grade.

   As you scroll from clip to clip, a purple outline indicates the clip with the grade being previewed and an orange outline indicates the current clip to which you’re previewing each scrolled grade.

   When you’re finished, do one of the following to either accept or reject the currently previewed grade that you’ve scrolled to:
   - Press EXIT AS WAS if none of the grades you scrolled through was suitable. This exits Scroll mode and leaves the clip as it was previously.
   - Press EXIT AS IS if you’ve found a grade that works for the current clip. This exits Scroll mode and copies the scrolled grade.

When you press the TOGGLE DECK KEYS soft key in Scroll mode, each of the Transport Control buttons on the Search Dial panel functions as a means of previewing the grades of other clips in the Timeline.

   - NEXT CLIP: Move to the next clip and preview its grade.
   - PREV CLIP: Move to the previous clip and preview its grade.
   - FWD: Plays (scrolls) forward at 1 scene per second, previewing each new grade as it appears.
   - REV: Play (scrolls) the clips in reverse at 1 scene per second, previewing each new grade as it appears.
   - FFWD: Shuttles (scrolls) forward through the Timeline at 4 scenes per second, previewing each new grade as it appears.
   - RWD: Shuttles (scrolls) reverse through the Timeline at 4 scenes per second, previewing each new grade as it appears.
Rippling Changes Using the Advanced Control Panel

DaVinci Resolve has a mechanism for rippling specific changes made to one clip to a range of other clips in the Timeline. This is only possible using the controls of the DaVinci Resolve Advanced control panel.

The general idea of the ripple function is that you select a clip, make a change to one or more nodes in its grade, and then ripple that change to a range of other clips. This rippled change can be applied to the same node in each clip, or the change can be applied as an appended node within each rippled clip.

The following procedure describes in detail how you can use the control panel to ripple a change to a range of other clips. While this procedure may appear complicated, it’s just that there are several options. Once you learn the sequence of commands, this process is actually quite fast.

**To ripple a change using the Ripple Mode soft key commands:**

1. (Optional) On the T-Bar panel, press MODES, then in the soft menu of the Trackball panel press RIPPLE MODES. Four selectable modes appear mapped to the soft keys of the Trackball panel, which can be used later to execute different types of ripple operations. Press the mode you want to use for rippling.
   - **Ripple Static:** (Exact values changed) Changes made to the current clip are rippled to the specified clips using the exact parameters that were changed. For example, if Lift in the current clip is changed to 0.75 of its range, each clip you ripple will have a Master Gain setting of 0.75. Only parameters you adjust are rippled.
   - **Ripple Relative:** (Percent value changed) Changes made to the current clip are rippled to the specified clips by the percentage of change you made to the altered parameters. For example, if the current clip has a Lift level of 1.00 and is changed to 0.90 units, then the Lift setting of each clip you ripple will have a relative reduction of 10% relative to its previous value.
   - **Ripple Absolute:** (Unit value changed) Changes made to the current clip are rippled to the specified clips by the same delta of change, using whichever units make sense for the affected parameter. For example, if the current clip had a Lift of 0.80 and you increased it to 0.90, each rippled scene’s master gain level increases by 0.10.
   - **Ripple Forced:** (All values are copied) The current clip’s grade is rippled to the specified clips in its entirety. No comparison is made with the original clip’s parameters, and all memory parameters are rippled.

2. Move the playhead to the clip you want to adjust.

3. Adjust the grade of the current clip in the manner you want to ripple to other clips in the Timeline.

4. Now, you must define the range of clips you want to ripple to using the number pad on the Search Dial panel. The following combinations will work:
   - An absolute range of clips is defined by entering two clip numbers separated by a comma. For example, if you want to ripple the current change to clips 10 through 15, you’d press “10, 15”
   - To specify every clip from the beginning of the Timeline, use the Minus (–) key. For example, to specify a range of clips from the beginning to clip 20, you’d press “–, 20”
   - To specify every clip to the end of the Timeline, use the Plus (+) key. For example, to specify a range of clips from the clip 50 to the end, you’d press “50, +”
   - To specify every clip in the whole Timeline, press “–, +”

5. (Optional) You can control whether the rippled change is applied in an appended node, or an existing node, in every rippled clip by pressing the SHIFT DOWN key of any panel.

If you don’t press SHIFT DOWN, the rippled change will be applied to the same node in every rippled clip that was adjusted in the current clip. In other words, if you made a change to Node 4, it will be rippled to Node 4 of all clips specified for rippling to. If one of the rippled clips doesn’t have the same number of nodes (in this case if there’s no node 4), you may get an error.
To execute the ripple, do one of the following:

– Press RIPPLE VALUE on the Search Dial panel to ripple a change to the selected node in each clip’s grade, using the currently selected Ripple Mode in the Color panel of the User Preferences.

– Press SHIFT DOWN and APPEND to ripple to add the change via an appended node at the end of each clip’s grade

– Press one of the Center panel soft keys corresponding to the ripple function you want to perform.

There are four soft keys;

a. Static Ripple: Changes made to the current clip are rippled to the specified clips using the exact parameters that were changed. For example, if Lift in the current clip is changed to 0.75 of its range, each clip you ripple will have a Master Gain setting of 0.75. Only parameters you adjust are rippled. Identical to the “Exact values changed” ripple setting.

b. Relative Ripple: Changes made to the current clip are rippled to the specified clips by the percentage of change you made to the altered parameters. For example, if the current clip has a Lift level of 1.00 and is changed to 0.90 units, then the Lift setting of each clip you ripple will have a relative reduction of 10% relative to its previous value. Identical to the “Percent value changed” ripple setting.

c. Absolute Ripple: Changes made to the current clip are rippled to the specified clips by the same delta of change, using whichever units make sense for the affected parameter. For example, if the current clip had a Lift of 0.80 and you increased it to 0.90, each rippled scene’s master gain level increases by 0.10. Identical to the “Unit value changed” ripple setting.

d. Forced Ripple: The current clip’s grade is rippled to the specified clips in its entirety, overwriting all previous nodes and parameters in the rippled clips.

Now, the adjustment you made in step 4 is applied to the designated range of clips.

Admittedly, that was a long and detailed procedure when spelled out in text, but the actual button sequences are straightforward once you put them together. Here are some examples of button sequences that ripple an adjustment you’ve just made in different ways:

– “10, 15” then SHIFT DOWN then RIPPLE VALUE: Copies the change you’ve made to the current clip and applies it as a new node that’s appended to the end of clips ten through fifteen.

– MODES then RIPPLE MODES then “34, 45” then FORCED RIPPLE: Copies the entire grade of the current clip, using it to overwrite the grade of clips 34 through 45.

– MODES then RIPPLE MODES then “–, +” then SHIFT DOWN then RELATIVE RIPPLE: Copies the change you’ve made to the current clip as a relative percentage and applies it as a new node appended to the end of every single clip in the entire Timeline.

WARNING

Since undo is a per-clip operation, there is no global undo for changes made to the entire Timeline. This means that once you ripple a change in this manner, there is no going back. Proceed with caution.
Color Page Effects
Chapter 149

Using Open FX and Resolve FX

This chapter covers the use of Resolve FX and Open FX plug-ins, that allow you to use the built-in filters that come with DaVinci Resolve, as well as third-party filters from a variety of companies, to create complex effects and adjustments that aren’t possible using the ordinary palette tools in the Color page.

Contents

Resolve FX 2962
Open FX 2962
Where are OFX Installed? 2963
Open FX Plug-Ins Can Be Processor Intensive 2963
Browsing the Open FX Library 2963
Open FX Library Favorites 2964
Using Resolve FX and Open FX in the Color Page 2965
Applying Resolve FX and Open FX Plug-Ins 2965
Adding a Plug-In to a Corrector Node 2965
Adding a Plug-In as a Stand-Alone OFX Node 2966
Resolve FX and Open FX Settings 2966
Editing Effects Using the Full Screen Viewer 2967
Resolve FX and Open FX Onscreen Controls 2968
Keyframing Resolve FX and OFX in the Inspector 2968
Motion Tracking Resolve FX and Compatible OFX Plug-Ins 2969
Resolve FX

Resolve FX are the built-in plug-ins that come with DaVinci Resolve. These plug-ins span the gamut from blurs and complex color adjustments to stylized image treatments and lighting effects to sharpen and repair operations that are too complex to accomplish using the palette controls of the Color page.

An image before/after using the Abstraction Resolve FX filter

Most Resolve FX plug-ins have been optimized for real-time playback, making it possible to apply complex effects such as Lens Flares, Light Rays, Film Grain, or Warping, and make adjustments while getting immediate, high-quality feedback, and enabling you to play each variation of your effect as you work without the need to wait for rendering or caching to happen first. Of course, if you’re working with extremely high-resolution or raw source media, if your workstation is particularly old, or if you’re applying many Resolve FX all at once, your performance may slow, necessitating the use of either the Smart Cache or User Cache.

Open FX

Open FX (OFX) is an open plug-in standard intended to enable easier development of cross-platform visual effects plug-ins for a variety of applications. Popular plug-in packages include BorisFX Sapphire and Continuum Complete, Red Giant Universe, and NewBlue TotalFX, all of which are ubiquitous tools for feature and broadcast work. The available Open FX plug-in packages are also growing every year as this format becomes more widely adopted among developers.

With Open FX support, you can use plug-ins to do many stylized operations that would be difficult or impossible to do using the other tools in DaVinci Resolve. Everything from lens flares, optical blurs and prism effects, lens warp correction, film and video grain and damage effects, dead-pixel corrections, and more can be accomplished with the right plug-in collection.

One of the many Sapphire OFX plug-ins from GenArts
The installation and licensing of Open FX plug-ins is handled by a vendor’s own installer. Once installed, Open FX plug-ins appear within the Library of the Open FX panel, which can be opened by clicking the FX button at the top right of the Color page or Edit page Interface toolbar.

**Where are OFX Installed?**

According to the standard governing how OFX work, all OFX plug-ins on a particular workstation are installed into a standardized location to foster plug-in compatibility with multiple applications. These locations are:

- **On macOS**: `/Library/OFX/Plugins`
- **On Windows**: `C:/Program Files/Common Files/OFX/Plugins`
- **On Linux**: `/usr/OFX/Plugins`

**Open FX Plug-Ins Can Be Processor Intensive**

Because they create such a wide variety of effects, some third-party Open FX plug-ins can be extremely processor intensive, all the more if you add multiple plug-ins to a single grade. If you find your playback performance dropping because of a particularly expensive effects operation, you can use the Smart Cache to automatically cache nodes and clips that have Open FX plug-ins applied to them. Once fully cached, you can play these clips back in real time, at least until you change that clip’s grade again. For more information on caching and on improving performance in DaVinci Resolve overall, see Chapter 7, “Improving Performance, Proxies, and the Render Cache.”

**Browsing the Open FX Library**

All of these built-in plug-ins appear within categories at the top of the Open FX Library.

When you click the FX button, the Open FX panel opens out of the right side of the Node Editor to show the Library, resizing the Viewer, Gallery, and Node Editor to make room. The Open FX Library is organized hierarchically. Each vendor’s plug-ins appear under a header with the name of that plug-in collection, and possibly organized into categories, separated by headers with Open or Close arrows that appear to the right of the category name, which let you show or hide the contents so that you can make the hierarchy as compact or spread out as you like.

**To open and close Open FX categories, do one of the following:**

- Move the pointer over the header you want to open or close, and click the Close or Open arrow to the right of the category name.
- To open or close all headers at once, Option-click the Open or Close arrow.
Since many Open FX plug-in collections are quite large, an optional Search field can be opened at the top of the Library that lets you quickly find plug-ins by name or partial name.

**To search for an Open FX filter by name:**

1. Click the magnifying glass button at the upper right-hand corner of the Open FX panel.
2. Type your search string into the Search field that appears. A few letters should be enough to isolate only those plug-ins that have that character string within their name.

**Open FX Library Favorites**

You can click on the far right of any Resolve FX or OFX filter to flag it with a star as a favorite filter. When you do so, choosing Favorites from the Effects Library option menu filters out all clips that are not favorites, letting you see only effects you most commonly use. To “de-favorite” any effect, click its star to turn it off.
Using Resolve FX and Open FX in the Color Page

This section provides an overview of procedures that describe how you can work with Open FX plug-ins within the Color page.

**Methods of working with Open FX:**

- **To add an Open FX plug-in to a node:** Drag a plug-in from the Open FX Library onto a node. If you drag a plug-in onto a node that already has a plug-in, the previous plug-in will be overwritten.

- **To remove an Open FX plug-in from a node:** Right-click a node showing the FX badge, and choose Remove OFX Plug-in from the contextual menu.

- **To add an Open FX plug-in as a separate node:** Drag a plug-in from the Open FX Library onto a connection line in the Node Editor. A new node is created and labeled with the name of the Open FX plug-in.

- **To edit the parameters of an Open FX plug-in:** Select any node with an FX badge, and open the Open FX Panel to show the Settings list. You can switch to the Library by clicking the Library button.

- **To sample a color parameter within an Open FX plug-in:** Some OFX plug-ins have a color swatch parameter, which exposes an eyedropper button in the Settings. Clicking the eyedropper turns the pointer into an eyedropper you can use to sample the contents of the Viewer.

- **To use Open FX onscreen controls in the Viewer:** Select any node with an FX badge, and the onscreen controls, if there are any, should appear in the Viewer. If not, make sure the Viewer mode drop-down is set to FX.

### Applying Resolve FX and Open FX Plug-Ins

Once you’ve found an Open FX plug-in you want to use in the Library, there are two ways of applying it within the Node Editor of the Color page. Which method you use depends on how you want to use that plug-in.

### Adding a Plug-In to a Corrector Node

If you want to combine an Open FX plug-in with a grade within a single node, simply drag and drop it onto a new corrector node to apply that plug-in's effect to that node. Nodes with an Open FX plug-in applied have an FX badge in the bottom left-hand corner.

![A node with an Open FX plug-in applied](image)

You can only apply one Open FX plug-in to a node at a time, but by using multiple nodes you can add as many Open FX plug-ins to your grade as you need.
When added to a corrector node, Open FX are applied after Motion Blur and Noise Reduction, but before anything else. This means you can use Motion Blur and Noise Reduction to pre-process the image before it’s handed off to the Open FX plug-in. This also means that all other adjustments you make within that node are applied to the Open FX plug-in’s output.

However, the principal advantage of adding plug-ins to corrector nodes is that you can use secondary operations such as a window, a qualifier, or a key to limit that plug-in’s effect, much as you would limit any other kind of adjustment you’d make with a corrector node.

**Adding a Plug-In as a Stand-Alone OFX Node**

If you want to add an Open FX plug-in to your grade as a stand-alone effect, you can simply drag any plug-in from the Open FX Library onto a connection line of your grade, and an Open FX node will be created.

The advantage of this is that it’s fast to apply plug-ins in this way, and this can be an easier way for you to add plug-ins that are more complicated, such as those having multiple inputs for creating compositing effects.

For example, the Lens Blur plug-in lets you connect a black and white image that’s been added to the node tree as an external matte to a Lens Blur node’s second RGB input to use to create custom bokeh effects when you set the Shape Type drop-down to External Input.

**Resolve FX and Open FX Settings**

When you select a node with a Resolve FX or Open FX plug-in applied to it, the Open FX panel switches to the Settings, which show you every single parameter associated with that plug-in, ready for customization.
Adjust any of the standard controls to manipulate that plug-in’s effect on the image.

**Editing Effects Using the Full Screen Viewer**

Because the Open FX panel can often be too short to present the full controls of more complicated filters, it remains visible when you switch to the Full Screen Viewer mode in the Color page. Jump into this mode by choosing Workspace > Viewer Mode > Full Screen Viewer (Shift-F).

This control layout makes it considerably easier to do detailed work while viewing a larger image and having all of your effects visible in a taller panel off to the side.

**TIP:** You can also open and close the Node Editor while in Full Screen Viewer mode, if you need to switch nodes while doing effects work.
Resolve FX and Open FX
Onscreen Controls

In the Edit page, Fusion page, and Color page, Resolve FX and Open FX display on-screen controls that you can use to visually edit an effect. In the Edit and Color pages, selecting an Open FX plug-in node or a plug-in in the Inspector that has onscreen controls automatically changes the Viewer’s mode to Open FX Overlay mode, with the available controls ready to use. Different plug-ins expose different custom controls, letting you control the effect or manipulate the image, depending on that plug-in’s function.

Adjusting the onscreen controls exposed by the GenArts Sapphire Glint Rainbow plug-in

If for whatever reason you switch the Viewer to another onscreen control mode (for example, showing the Window or Image Wipe controls), you can always switch back to the Open FX controls by choosing the Open FX Overlay mode from the onscreen control drop-down menu underneath the Viewer.

**TIP:** You may find that as you work you want to temporarily hide or show the onscreen controls in the Viewer so you can get an uncluttered look at the image you’re adjusting. You can quickly toggle any set of onscreen controls off and on without selecting Off in the menu by pressing Shift-` (tilde).

Keyframing Resolve FX and OFX in the Inspector

Resolve FX and Open FX can be keyframed in the Edit, Fusion, and Color pages. However, they can only be keyframed in the Edit and Color pages using the keyframing controls found in the Inspector (at the time of this writing). Happily, most simple keyframing tasks can be performed using three buttons that appear to the right of any parameter that’s capable of being keyframed. It takes two keyframes at minimum to create an animated effect.

The three keyframe controls that appear in the Inspector, from left to right: Previous keyframe, Create/ Delete keyframe, Next keyframe
Methods of keyframing parameters in the Inspector:

– **To add a keyframe:** Select a clip, open the Inspector, then move the Timeline playhead to the frame where you want to place a keyframe, and click the Keyframe button next to the parameter of the Inspector you want to animate. Once you’ve added at least one keyframe to a parameter, all other adjustments you make to parameters in the Inspector, or using the onscreen Transform/Crop controls in the Timeline Viewer, add new keyframes automatically if the playhead is at another frame.

– **To move the playhead to the next or previous keyframe:** Click the small left- or right-hand arrow to either side of a parameter’s keyframe control, or press Right-Bracket ( ] ) or Left-Bracket ( [ ), to jump the playhead to the next or previous keyframe.

– **To edit an existing keyframe of a parameter:** Move the playhead to be on top of the keyframe you want to edit, and then change that parameter, either in the Inspector, or using the onscreen controls of the Timeline Viewer.

– **Methods of changing keyframe interpolation in the Inspector:**

    – **To change a keyframe to Static:** (Color page only) Static keyframes create abrupt one-frame changes at the keyframe to which they’re applied, which is good for creating sudden effects. Move the playhead to a frame with a keyframe using the next/previous keyframe controls, then right-click the orange keyframe button and choose “Change to Static Keyframe.” The keyframe control changes to a round button to show that keyframe is now Static.

    – **To change a keyframe to Dynamic:** Move the playhead to a frame with a keyframe using the next/previous keyframe controls, then right-click the orange keyframe button and choose “Change to Dynamic Keyframe.” The keyframe control changes to a diamond button to show that keyframe is now Dynamic.

Methods of deleting keyframes and disabling keyframed effects:

– **To delete a single keyframe:** Open the Inspector, move the Timeline playhead to a frame with a keyframe, and click the orange Keyframe button in the Inspector to delete it.

– **To delete all keyframes for one parameter:** Click the reset button to the right of a parameter’s keyframe control in the Inspector.

– **To delete all keyframes in a group of parameters in the Inspector:** Click the reset button to the right of a parameter group’s title bar in the Inspector.

– **To disable or enable a single parameter’s keyframed effect:** In the Timeline, click the toggle control at the left of a parameter’s keyframe track. A white dot means it’s enabled, while no dot means it’s grayed-out and disabled.

– **To disable or enable a group of parameters in the Inspector:** Click the toggle control at the left of a parameter group’s title bar in the Inspector. Orange means that group is enabled. Gray is disabled.

**Motion Tracking Resolve FX and Compatible OFX Plug-Ins**

When using Resolve FX in the Color page, Resolve FX that have position parameters, including Dent, Lens Flare, Light Rays (when “From a Location” is selected), Mirrors, Radial Blur, Ripples, Vortex, and Zoom Blur can all be motion tracked to follow the position of a moving subject in the frame using the point-based tracking in the FX mode of the Tracker palette.
To match move Resolve FX to a feature using the FX tracker:

1. Create a new node, and drag the Resolve FX filter you want to apply onto that node to apply the effect. In this example, we’re adding a Lens Flare effect, that has the position parameters necessary to be match moved to follow the motion of the shot, and we’re choosing the MIR-I 2.8/37 preset, which looks like a sun.

![Applying a Lens Flare to the shot](image)

2. If necessary, use the onscreen controls in the Viewer or the X Position and Y Position sliders to move the Resolve FX effect to where you want it.

![Moving the Lens Flare using the onscreen controls](image)

3. Next, open the Tracker Palette and choose FX from the mode drop-down.

![Opening the FX tracker mode of the Tracker palette](image)

4. Click the Add Tracker Point button, at the bottom left-hand side of the Tracker palette, to add tracker crosshairs to the center of the Viewer.

![Adding a point tracker](image)

5. Drag the crosshairs to a high-contrast detail (such as a small object or corner), and click the Track Forward button. In this example, there’s a rock out at sea that will make a good plane of motion for tracking a far-away sun. There is no inner or outer box to position or resize while you do this; you just need to drag the crosshairs to center on the feature you want to track.
6 Now, click the Track Forward button, and DaVinci Resolve will track the feature. The Resolve FX applied to that node will simultaneously move to follow the track, and when the tracking is done, you’re finished.

7 After you’ve finished tracking, you can freely reposition the Resolve FX to offset it from the track. For more information about single-point tracking, see the “Point Tracker Workflows” section of Chapter 137, “Motion Tracking Windows.”
Chapter 150

Sizing and Image Stabilization

DaVinci Resolve has a powerful toolset for making geometric transforms, using advanced algorithms for optical-quality sizing operations. This section covers the nuts and bolts of resolution independence in DaVinci Resolve, and how to use the Sizing palette. This chapter also covers how to use the Stabilizer mode of the Tracker palette to subdue unwanted camera wiggle.

Contents

The Five Color Page Sizing Modes ................................................. 2973
Sizing Order of Processing on the Color Page ......................... 2973
Sizing Controls ........................................................................ 2973
Blanking Controls .................................................................. 2974
Resetting the Sizing Palette ...................................................... 2975
Input and Output Sizing Presets .............................................. 2975
Sizing Controls with the DaVinci Control Panel ................... 2976
Using Node Sizing for Channel and Paint Effects ................ 2977
Image Stabilization in the Tracker Palette ............................. 2978
Using the Stabilizer ................................................................. 2978
Using the Classic Stabilizer ...................................................... 2980
Using Stabilization to Create a Match Move ......................... 2985
Tracking and Stabilizing with the DaVinci Control Panel ........ 2986
The Five Color Page Sizing Modes

The Sizing Palette on the Color page can be put into one of five modes, each of which accomplishes a different task.

– **Edit Sizing**: These controls mirror those found in the Inspector of the Edit page.

– **Input Sizing**: These controls let you make sizing adjustments to individual clips that affect their overall geometry (pan, tilt, zoom, and rotation). These controls are useful for doing clip-by-clip pan and scan adjustments.

– **Output Sizing**: These controls are nearly identical, except that they affect every clip in the entire timeline, all at once. Output sizing is useful for making a formatting adjustment to an entire timeline, such as changing an HD timeline to an SD timeline with simple adjustments to crop and pan the resulting framing.

– **Node Sizing**: Lets you add targeted sizing adjustments at any point within the node tree. Like Input Sizing, Node Sizing is specific to a particular clip. Unlike Input Sizing, Node Sizing is affected by operations that split color channels (such as the splitter/combiner nodes) and limit the image (such as qualifiers and windows). You can also add as many node sizing adjustments to a clip’s grade as you need.

– **Reference Sizing**: A set of sizing controls that lets you reposition the still when a wipe comparison is being made. Using these controls, you can move the still image to better compare it to the clip you’re wiping it against. The Reference Sizing controls only work when you have a wipe enabled.

Sizing Order of Processing on the Color Page

Input Sizing adjustments are applied before all image processing that takes place in the node graph, including Node Sizing, while Output Sizing adjustments are applied after image processing in the node graph.

Sizing Controls

Input, Node, and Output Sizing share many of the same controls. When the Sizing palette is set to Input Sizing mode, the controls transform each clip individually. If you’re simply pushing in on one or two clips, or making individual pan and scan adjustments to account for a change in format, these are the controls you want to use.

![The Sizing palette](image)

– **Pan**: Moves the clip along the horizontal, X axis. Positive values move the clip right, negative values move the clip left.

– **Tilt**: Moves the clip along the vertical, Y axis. Positive values move the clip up, negative values move the clip down.
– **Zoom:** Adjusts the overall dimensions of the clip. The range is from 0.250 (1/4x size) to 4.000 (4x size). Normal size is 1.000.

– **Rotate:** Positive values rotate the clip clockwise. Negative values rotate the clip counter-clockwise.

– **Width:** Stretches the image wider or narrower. The range is from 0.250 (1/4x width) to 4.000 (4x width). Normal width is 1.000.

– **Height:** Stretches the image taller or shorter. The range is from 0.250 (1/4x height) to 4.000 (4x height). Normal height is 1.000.

– **Pitch:** Rotates the image toward or away from the camera along an axis running through the center of the image, from left to right. Positive values push the top of the image away and bring the bottom of the image forward. Negative values bring the top of the image forward and push the bottom of the image away. Higher values stretch the image more extremely.

– **Yaw:** Rotates the image toward or away from the camera along an axis running through the center of the image from top to bottom. Positive values bring the left of the image forward and push the right of the image away. Negative values push the left of the image away and push the right of the image forward. Higher values stretch the image more extremely.

– **Key Lock:** (Node Sizing only) Lets you choose how regions of the image that are isolated by one or more windows will be transformed. There are two options:
  – **Off:** While off, the transform controls will move the windowed region to another area of the frame, effectively duplicating the windowed area.
  – **On:** While on, the transform controls will move other areas of the frame into the windowed regions, effectively covering up the windowed area with another portion of the picture.

– **Flip Image:** Two buttons let you flip the image in different dimensions.
  – **Flip Horizontal control:** Reverses the image along the X axis, left to right.
  – **Flip Vertical control:** Reverses the clip along the Y axis, turning it upside down.

– **Lens Correction:** (Edit Sizing only) Two controls let you correct for lens distortion in the image, or add lens distortion of your own (only available in the Studio version).
  – **Analyze:** Automatically analyzes the frame in the Timeline at the position of the playhead for edges that are being distorted by wide angle lens. Clicking the Analyze button modifies the effect of the Distortion slider so that it gives a more accurate result, but it doesn’t perform a correction.
  – **Distortion:** Dragging this slider to the right applies a warp to the image that lets you straighten the bent areas of the picture that can be caused by wide angle lenses. It’s not necessary to click the Analyze button prior to using this slider, but using the Analyze button can improve the accuracy of the result.

### Blanking Controls

Output Sizing mode also has a set of Blanking controls that you can use to add custom blanking to a clip or project. For example, you can use these controls to add nonstandard letterboxing or pillarboxing to an image. Along with all other Output Sizing adjustments, blanking is added last in the image processing pipeline, so it’s not affected by any of the color or contrast adjustments you make.

– **Top:** Adjusts the top letterbox.

– **Right:** Adjusts the right pillarbox.

– **Bottom:** Adjusts the bottom letterbox.

– **Left:** Adjusts the left pillarbox.

– **Smooth:** A checkbox that lets you turn on edge anti-aliasing for source blanking. Overrides the Anti-alias Edges drop-down menu found in the Image Scaling panel of the Project Settings.
NOTE: It might be necessary to turn anti-aliasing off if you notice black blurring at the edges of blanking being applied to an image.

Blanking presets are also available by choosing from the Timeline > Output Blanking submenu. Choosing one of these options automatically sets the Blanking parameters of the Sizing palette’s Output Sizing mode. The following presets are available:

- **1.33**: SD or 4:3
- **1.66**: European theatrical
- **1.77**: HD or 16:9
- **1.85**: Theatrical flat aspect ratio
- **2.00**: Univisium. Aspect ratio designed to accommodate both theatrical wide-screen and HD delivery.
- **2.35**: Original anamorphic (scope) theatrical wide-screen
- **2.39**: Current 35mm anamorphic (scope) theatrical wide-screen
- **2.40**: Current 35mm anamorphic (scope) theatrical wide-screen (rounded up for Blu-Ray)
- **Reset**: Restores the clip to its original aspect ratio.

Anti-aliasing at the edges of blanking is handled by an Anti-Alias Edges setting in the Image Scaling panel of the Project Settings. For more information, see Chapter 4, “System and User Preferences.”

**Resetting the Sizing Palette**

You can reset every control within the Sizing palette at any time by clicking the reset button in the upper right-hand corner of the palette.

**Input and Output Sizing Presets**

If there are Input or Output Sizing settings that you find yourself using repeatedly, you can save them as presets for easy recall. For example, if there’s a group of input settings that you use to resize a clip of a particular format to match the current project, you can save it as a preset that you can use whenever.

- **Preset drop-down menu**: Provides access to all the currently saved presets in the current database.
- **Delete Preset**: To delete a preset, select it from the drop-down menu, click the trash can button, then click OK.
- **Save As New Preset**: To add a preset, make whatever settings adjustments you need, then click the plus button. When the Format Preset dialog appears, enter a name, check that the settings are correct, then click Save in the Format Preset window.
- **Update Preset**: To change a preset, load the preset you want to change, make whatever changes you need, then click Update in the Format Preset window.

The Input and Output Sizing modes save different presets. Each of these sets of presets is available from the “Override input scaling” and “Override output scaling” drop-down menus in the Image Scaling project setting menu.
Sizing Controls with the DaVinci Control Panel

There are two sets of DaVinci control panel mappings for the sizing controls. The most obvious controls can be seen permanently mapped to the knobs and soft keys of the Transport panel. This makes these controls easy to access for projects where you’re panning and scanning nearly every shot of a film-scanned program.

To adjust PTZR settings:
1. Press the OUTPUT or INPUT soft key to switch between Output Sizing and Input Sizing modes.
2. Use the PAN, TILT, ZOOM, and ROTATE knobs of the Transport panel, and the H FLIP and V FLIP soft keys.

To adjust Input and Output Blanking:
1. Press the INPUT BLANKING or OUTPUT BLANKING soft key on the Transport panel.
2. Use the knobs labeled LEFT, RIGHT, TOP, and BOTTOM to make a blanking adjustment.
3. Press SIZING when you’re finished.

Another set of DaVinci control panel mappings appears when you press the SIZING button of the T-bar panel. In this case, the Center panel knobs and soft keys update to a page showing the following:

– **Ref Wipe Sizing Adjustments:** These controls, on the middle screen of the Center panel, let you reposition a still from the Gallery that’s being displayed in a split screen. This can make it easier to compare features that would otherwise be obscured by the still’s position on screen.

– **Input Sizing Adjustments:** The Input Sizing controls are displayed on the right screen of the Center panel. These are similar to the mappings on the Transport panel, but the Center panel’s second row of knobs also exposes PITCH, YAW, H SIZE, and V SIZE controls, and there’s an additional MODIFY PAR button that lets you change the pixel aspect ratio of a clip.

– **Output Sizing Adjustments:** If you press the OUTPUT soft key on the Center panel, the knobs and soft keys change to show the Output Sizing controls. Press BLANKING to expose all the preset aspect ratios on the Transport panel, along with the USER which allows you to expose user definable presets.

To save and recall user definable blanking aspect ratios:
1. Press SIZING on the T-bar panel.
2. Press the OUTPUT soft key on the Center panel.
3. Press the OUTPUT BLANKING soft key on the Transport panel, and then enter the blanking aspect ratio as a number (e.g., 2.4) using the number pad on the Transport panel to set your customized blanking.
4. Press the BLANKING soft key on the Center panel.
5. To apply the new ratio, press the BLANKING soft key on the Center panel, then press USER on the Transport panel, and press one of the USER 1–5 soft keys.

**TIP:** With the Input Sizing Adjustments controls exposed on the Center panel, you can set the Transport panel to display the Output Sizing controls, for simultaneous presentation of every sizing control that’s available.
Using Node Sizing for Channel and Paint Effects

Using Node Sizing, you can apply individual sizing adjustments on a per-node basis. All Node Sizing adjustments within a grade are cumulative, and any keyframing done to Node Sizing parameters is stored in that node’s Node Format keyframe track in the Keyframe Editor. Two good examples of Node Sizing include realigning color channels individually in conjunction with the Splitter/Combiner nodes, or duplicating windowed regions of an image by moving them around the frame.

Example 1

**Using node sizing on individual color channels:**

1. Choose Color > Nodes > Add Splitter/Combiner Node to add this node structure to the current grade.

2. Select one of the three Corrector nodes connected between the Splitter and Combiner nodes that corresponds to the color channel you want to transform.

3. Open the Sizing palette, choose Node Sizing from the mode drop-down, and use the Sizing parameters to transform that channel as necessary. For example, if you have an old video clip with misaligned color components, you could pan a misaligned channel to the left or right to try and improve its alignment.

---

Before and after panning the green channel
Example 2

Using Node Sizing to duplicate a windowed area of an image to cover a blemish:

1. Create a new node.
2. Open the Window palette, create a Circular window, and then shrink and reposition it to surround a feature you want to remove.
3. Open the Tracking palette, and track the window to follow the feature to be removed.
4. After the track is complete, now move the window to an adjacent area of clean detail that’s right next to the feature you want to remove. This is the area of the image you’re going to duplicate and cover the unwanted feature with.
5. Now, open the Sizing palette, choose Node Sizing from the mode drop-down, check Key Lock, and use the Sizing parameters to move a duplicate of the windowed area to cover up the unwanted feature.

Before/after using Node Sizing to clone an area of the image to cover up the actor with a plant to create a clean background

When you’re done, playing through the clip should show that the duplicated area of the image is still tracking the feature you want to remove.

Image Stabilization in the Tracker Palette

The Image Stabilization mode of the Tracker palette lets you smooth out or even steady unwanted camera motion within a clip. The analysis is performed in such a way as to preserve the motion of individual subjects within the frame, as well as the overall direction of desirable camera motion, while correcting for unsteadiness.

Using the Stabilizer

DaVinci Resolve uses an advanced stabilizer that’s capable of both warping and translation to minimize unwanted shaking in a clip replaces the classic stabilization tools that were available previously (these tools are still available should you need specific capabilities of the older toolset, and are covered in a later section). With a single click of the Stabilize button, the currently selected clip is analyzed and automatically stabilized using a combination of warping and image translations.
The default Stabilizer controls

**Stabilizer Parameters and Controls**

The default settings yield good results for most situations, but there are ways you can customize stabilization in situations where unique issues arise.

A drop-down menu provides three different options that determine how the selected clip is analyzed and transformed during stabilization. You must choose an option first, before clicking the Stabilize button, because the option you choose changes how the image analysis is performed. If you choose another option, you must click the Stabilize button again to reanalyze the clip.

- **Perspective:** Enables perspective, pan, tilt, zoom, and rotation analysis and stabilization.
- **Similarity:** Enables pan, tilt, zoom, and rotation analysis and stabilization, for instances where perspective analysis results in unwanted motion artifacts.
- **Translation:** Enables pan and tilt analysis and stabilization only, for instances where only X and Y stabilization gives you acceptable results.

The other controls let you customize how aggressively the selected clip is stabilized.

- **Bypass Stabilization:** This checkbox lets you turn stabilization off and on to be able to compare the stabilized and unstabilized image.
- **Cropping Ratio:** This value limits how hard the stabilizer tries to stabilize, by dictating how much blanking or zooming you’re willing to accept in exchange for eliminating unwanted motion. A value of 1.0 results in no stabilization being applied. Progressively lower values enable more aggressive stabilization. Changing this value requires you to click the Stabilize button again to reanalyze the clip.
- **Smooth:** Lets you apply mathematical smoothing to the analyzed data used to stabilize the clip, allowing camera motion in the shot while eliminating unwanted jittering. Lower values perform less smoothing, allowing more of the character of the original camera motion to show through, while higher values smooth the shot more aggressively. Changing this value requires you to click the Stabilize button again to reanalyze the clip.
- **Strength:** This value is a multiplier that lets you choose how tightly you want to use the stabilization track to eliminate motion from a shot using the current analysis. With a value of 1.00, stabilization is maximized. Since some clips might look more natural with looser stabilization, choosing a number lower than 100 lets a percentage of the original camera motion show through. Zero (0) disables stabilization altogether. As an additional tip, you can invert the stabilization by choosing –1.00 when pasting a stabilization analysis from another clip to perform a match move based on the overall motion of the scene, and you can use a negative value either lower or higher than –1.00 to under or overcompensate when inverting the stabilization, simulating the effects of parallax where foreground and background planes move together but at different speeds.
– **Camera Lock**: Turning on this checkbox disables Cropping Ratio and Smooth, and enables the stabilizer to focus on eliminating all camera motion from the shot in an effort to create a locked shot.

– **Zoom**: When this checkbox is turned on, the image is resized by a large enough percentage to eliminate the blanking (black edges) that is the result of warping and transforming the image to eliminate unwanted camera motion. The lower a value Cropping Ratio is set to, the more DaVinci Resolve will need to zoom into an image to eliminate these blanked edges. If you turn this off, the image is not zoomed at all, and whatever blanking intrudes into the image is output along with the image, on the assumption that you’ll have dedicated compositing artists deal with eliminating this blanking by filling in the missing image data in a more sophisticated manner. You may also leave this checkbox turned off if you’re planning on animating the Input Sizing Zoom parameter to dynamically zoom into and out of a shot being stabilized to eliminate blanking only where it occurs, using only as much zooming as is necessary for each region of the shot.

### Using the Classic Stabilizer

The “classic” image stabilizer controls available in DaVinci Resolve version 12.5 and earlier are still available, simply select “Classic Stabilizer” from the option menu of the Tracker palette. Classic image stabilization in DaVinci Resolve consists of three steps. First, you analyze the clip. Second, you choose the Stabilization settings you want to use. Third, you click Stabilize to calculate the result.

When analyzing the clip, you can choose to use either the default Cloud Tracker, which automatically finds as many trackable points as possible throughout the image and calculates stabilization based on all of them, or you can use the Point Tracker, which lets you manually place one or more individual crosshairs on image features that you select. For more information on using the Point Tracker for window tracking, see Chapter 137, “Motion Tracking Windows.”

![The Classic Stabilizer mode of the Tracker palette](image)

As with object tracking, you can choose which aspects of motion to stabilize, but this must be done before you do the initial image analysis.

### Analyze Controls

The Analyze controls automatically scan through the entire clip, identifying trackable features that can be used to stabilize the shot.

A series of four checkboxes let you turn on and off which axes you’d like to stabilize. These checkboxes must be selected before you perform an analysis in order to restrict the data that’s generated.

– **Pan**: Enables horizontal stabilization.

– **Tilt**: Enables vertical stabilization.
– **Zoom**: Enables stabilization of size.
– **Rotate**: Enables stabilization of orientation.

**NOTE**: Once stabilization has been done, disabling these checkboxes does nothing to alter the result. To make changes, you need to enable or disable the necessary checkboxes first, and then reanalyze the clip.

The five direction buttons let you perform the stabilization analysis.

– **Track One Frame Reverse**: Initiates tracking from the current frame backward by a duration of one frame.
– **Track Reverse**: Initiates tracking from the current frame backward, ending at the first frame of the clip.
– **Pause**: Stops tracking (if you’re fast enough to click this button before tracking is finished).
– **Track Forward**: Initiates tracking from the current frame forward, ending at the last frame of the clip.
– **Track One Frame Forward**: Initiates tracking from the current frame forward by a duration of one frame.

**Interactive Mode Controls**

The Interactive controls let you make manual changes to the automatically generated tracking point cloud that DaVinci Resolve creates, so you can try different ways of obtaining better stabilization results in challenging situations.

– **Interactive Mode checkbox**: Turns the Interactive stabilization mode on and off. When you enter Interactive mode, you can manually alter the point cloud that DaVinci Resolve uses to stabilize the image. You'll then make your analysis while in Interactive mode. When you exit Interactive mode, your manual changes to the point cloud are eliminated, and DaVinci Resolve again uses automatically placed point clouds to do all stabilization.
– **Insert**: Lets you add tracking points to whatever analyzable features exist within a bounding box that you’ve drawn in the Viewer. Inserted stabilization points are automatically placed.
– **Set Point**: Lets you use the cursor (using the DaVinci Resolve control panel), to manually place individual tracking points, one by one, with which to track a feature. If there is no trackable pixel group at the coordinates where you placed the cursor, a tracking point will be placed at the nearest trackable pixel group. You must place at least two tracking points at different pixel groups to track rotation, and at least three to track zoom.
– **Delete**: Eliminates all stabilization points within a bounding box that you’ve drawn in the Viewer.

The procedures for using Interactive mode for stabilization are the same as for tracking. For more information, see Chapter 137, “Motion Tracking Windows.”

**Stabilization Parameters and Controls**

There are five controls in the Stabilization group:
– **Strong:** Lets you choose how tightly you want to use the stabilization track to eliminate motion from a shot. With a value of 100, stabilization is maximized in an effort to “lock” the shot in place and eliminate all camera motion. This value is a multiplier. Since some clips might look more natural with looser stabilization, choosing a number lower than 100 lets a percentage of the original camera motion show through. Zero (0) disables stabilization altogether. Additionally, you can invert the stabilization by choosing –100, as described in the section on performing a match move below, and you can use a negative value either lower or higher than –100 to under or overcompensate when inverting the stabilization, simulating the effects of parallax where foreground and background planes move together but at different speeds.

– **Smooth:** Lets you apply mathematical smoothing to the analyzed data used to stabilize the clip, and is meant to be used when the Strong parameter is less than 100, allowing camera motion in the shot while eliminating unwanted wiggling. Lower values perform less smoothing, allowing more of the character of the original camera motion to show through, while higher values smooth the shot more aggressively.

– **Zoom:** When this checkbox is turned on, the image is resized by a large enough percentage to eliminate the blanking (black edges) that is the result of repositioning the image to eliminate unwanted camera motion. The higher a value Smooth Frames is set to, the more DaVinci Resolve will need to zoom into an image to eliminate these blanked edges. If you turn this off, the image is not zoomed at all, and whatever blanking intrudes into the image is output along with the image, on the assumption that you’ll have dedicated compositing artists deal with eliminating this blanking by filling in the missing image data in a more sophisticated manner. You may also leave this checkbox turned off if you’re planning on animating the Input Sizing Zoom parameter to dynamically zoom into and out of a shot being stabilized to eliminate blanking only where it occurs, using only as much zooming as is necessary for each region of the shot.

– **Tracker Type:** A drop-down menu below the Tracker graph lets you choose whether to use the Cloud Tracker or the Point Tracker. The default Cloud Tracker automatically finds as many trackable points as possible throughout the image and calculates stabilization based on all of them. This is fast, but can result in problems if there are too many prominent subjects in the frame with different vectors of motion. The Point Tracker, by contrast, lets you manually place one or more individual crosshairs on image features that you select. This involves more steps, but has the advantage of letting you choose exactly which features exhibit the motion you’re trying to stabilize. For more information on using the Point Tracker for window tracking, see Chapter 137, “Motion Tracking Windows.”

– **Stabilize:** After you’ve tracked the clip and adjusted the previous two controls, you need to click Stabilize to calculate the resulting effect of the Strong, Smooth, and Zoom controls on your clip. Whenever you make changes to the Strong, Smooth, or Zoom parameters, you need to click Stabilize to recalculate the resulting effect on your clip.

**Classic Stabilization With the Cloud Tracker**

Classic Image stabilization in DaVinci Resolve is easy, but you need to follow a specific series of steps for it to be successful.

**To stabilize an image:**

1. Open the Tracker palette, and choose Stabilizer from the Palette mode drop-down menu. Select Classic Stabilizer in the option menu. Make sure the Tracker Type drop-down menu at the bottom right of the Tracker palette is set to Cloud Tracker.

2. Turn off any of the Analyze checkboxes (Pan, Tilt, Zoom, Rotate, Perspective 3D) that correspond to transform axes you don’t want to smooth.

3. Click the Track Forward button to track the clip forward (or Track Reverse if you’d rather start from the end of the clip and work backward).
Multiple tracking points are automatically placed to analyze the motion of the image for stabilization.

This analyzes the clip, but no stabilization is yet applied.

4 Adjust the Strong parameter to reflect what kind of stabilization you want. If you want to eliminate all possible motion from the shot, leave Strong set to 100. If you want to use stabilization to smooth out the shot but leave some motion in the frame, reduce the strong parameter to be less than 100 but greater than 0. This parameter is a multiplier, so higher numbers reflect a higher percentage of smoothing being applied to the clip’s range of motion, and lower numbers reflect a lower percentage of smoothing being applied to the original range of motion.

5 If you’ve set the Strong parameter to a value less than 100 to calm the motion in the shot, rather than lock the shot completely, you can also adjust the Smooth parameter to mathematically smooth what motion remains in the shot. This lets you even out any “wobbling” that you don’t want, while retaining the camera motion that you do want. The Strong and Smooth parameters work together, so experiment with different values in each parameter to get the result you need.

6 Choose how you want the edges of the stabilized clip to be handled using the Zoom checkbox:
   – If you want DaVinci Resolve to zoom into the image as much as is necessary to prevent blanking (black edges) from intruding into the frame (the result of repositioning the image to steady camera motion), then turn on the Viewer Zoom checkbox.
   – If you want to leave the scale of the image alone, allowing blanking (black edges) to intrude into the frame so that you either (a) have an effects artist deal with filling in these holes later, or (b) manually animate the Input Sizing Zoom parameter to eliminate blanking in a dynamic way, then turn off the Viewer Zoom checkbox.

7 With all of these controls adjusted, click Stabilize. The clip is immediately transformed to apply the amount of stabilization you selected via the Smooth Frames slider.

8 Play the clip and examine the stabilization effect. If you need to make any changes, choose new Strong and Smooth Frames values, then click Stabilize. Any time you change any of the Stabilization parameters, you need to click Stabilize to recalculate the resulting transform to your clip.

Classic Stabilizing Using the Point Tracker

For clips in which there are too many moving subjects for the Cloud Tracker to get a solid lock, you need to track a very specific feature in order to successfully stabilize the image. In these cases, it’s often faster to use the Point Tracker for stabilization.

To stabilize an image using the Point Tracker:

1 Open the Tracker palette, and choose Stabilizer from the Palette mode drop-down menu. Select Classic Stabilizer from the option menu.
Choose Point Tracker from the Tracker Type drop-down menu at the bottom right of the Tracker palette. This changes the available controls under the tracker graph.

Click the Add Tracker Point button to add a crosshairs to the Viewer, and drag it to a high-contrast, angular feature you want to track that's indicative of the overall motion of the clip.

![Using the Point Tracker to stabilize an image](image)

**TIP:** You can optionally add more than one Tracker crosshairs to track multiple features, and DaVinci Resolve will attempt to stabilize as many dimensions as are made possible by the additional trackers. One point lets you stabilize Pan and Tilt. Two points lets you try to stabilize Pan, Tilt, and Rotation. Four points lets you try to stabilize Pan, Tilt, Rotation, and Zoom.

Click the Track Forward button to track the clip forward (or Track Reverse if you’d rather start from the end of the clip and work backward).

This analyzes the feature you chose to track with the crosshairs, but no stabilization is yet applied.

Adjust the Strong parameter to reflect what kind of stabilization you want. If you want to eliminate all possible motion from the shot, leave Strong set to 100. If you want to use stabilization to smooth out the shot but leave some motion in the frame, reduce the strong parameter to be less than 100 but greater than 0. This parameter is a multiplier, so higher numbers reflect a higher percentage of smoothing being applied to the clip’s range of motion, and lower numbers reflect a lower percentage of smoothing being applied to the original range of motion.

If you’ve set the Strong parameter to a value less than 100 to calm the motion in the shot, rather than lock the shot completely, you can also adjust the Smooth parameter to mathematically smooth what motion remains in the shot. This lets you even out any “wobbling” that you don’t want, while retaining the camera motion that you do want. The Strong and Smooth parameters work together, so experiment with different values in each parameter to get the result you need.

Choose how you want the edges of the stabilized clip to be handled using the Zoom checkbox:

- If you want DaVinci Resolve to zoom into the image as much as is necessary to prevent blanking (black edges) from intruding into the frame (the result of repositioning the image to steady camera motion), then turn on the Viewer Zoom checkbox.
- If you want to leave the scale of the image alone, allowing blanking (black edges) to intrude into the frame so that you either (a) have an effects artist deal with filling in these holes later, or (b) manually animate the Input Sizing Zoom parameter to eliminate blanking in a dynamic way, then turn off the Viewer Zoom checkbox.

With all of these controls adjusted, click Stabilize. The clip is immediately transformed to apply the amount of stabilization you selected via the Smooth Frames slider.

Play the clip and examine the stabilization effect. If you need to make any changes, choose new Strong and Smooth Frames values, then click Stabilize. Any time you change any of the Stabilization parameters, you need to click Stabilize to recalculate the resulting transform to your clip.
Using Stabilization to Create a Match Move

In some circumstances, such as when you’re using the HSL Qualifier to create transparency for a composite (using the Alpha Output described later in this chapter), you may find you need to apply the motion from a foreground clip to the background clip so that the two clips appear to be moving as one. This is referred to as doing a “match move,” and is a necessary step when creating a composite for purposes of doing a sky replacement, for example. This can be done in a simple way using the Stabilizer mode of the Tracker palette.

To match the motion of a background clip to a foreground clip:

1. First, in the Edit page, edit a foreground clip onto track V2, and a background clip with a more interesting sky onto track V1.

2. With that done, open the Color page and follow the instructions in the section titled “Using a Qualifier Key to Create Transparency” in Chapter 144, “Channel Splitting and Image Compositing,” to key the sky, and use that key to create a region of transparency in the foreground clip that lets the background sky clip in track V1 show through.

![Creating transparency to replace the sky in a superimposed clip with a sky image edited into a lower video track](image1)

In this example, the plain blue sky is being keyed so that it can be replaced with a more interesting photo of a dramatically cloudy sky.

![Before (top) and after setting up a sky replacement by connecting an HSL qualifier of the blue in the sky to the Alpha Output to create transparency](image2)

This procedure works equally well with still images or movie clips. Also, depending on the range of motion you’re going to be matching, you’ll probably need to use a background image that’s somewhat larger than the region you’re keying, to make sure you have full coverage as the layer moves to match the foreground motion. If necessary, you can zoom into the image using the Zoom parameter in the Transform section of the Edit page Inspector.

3. In this example, the foreground clip happens to have a camera pan, which gives the composite away as the sky doesn’t move along with it. To move the compound clip of the sky image to match this pan, open the Tracker pallet.

4. Choose its Stabilizer mode, and then click the Analyze Forward button to analyze the motion of the entire clip. Then, click the Tracker palette’s Option menu, and choose Copy Track Data.
5 Select the clip that you want to match (in this case the sky image), then open the Tracker Palette’s Option menu and choose Paste Track Data.

6 Now, for this to work correctly, you need to set the Strong parameter to –100, and click the Stabilize button. Setting a negative value inverts the tracking data you copied in step 3, which enables it to become a match move. If you’re feeling extra tricky, you can set the Strong parameter to a little less than –100, say –94, which introduces a disparity of foreground and background motion that simulates parallax.

Inverting the Strong parameter with a negative number to create matched motion

At this point, playing through the clip should result in a nicely matched correspondence between the movement of the foreground and background layers.

The background sky layer after it’s been matched to the motion of the foreground layer, the sky now follows along with the motion of the camera in the superimposed clip

Tracking and Stabilizing with the DaVinci Control Panel

All of the tracking commands are available via the DaVinci Resolve control panel.

To open and close tracking controls:
– Press OBJECT TRACK MODE at the top of the T-bar panel.
– All of the tracking controls appear on the soft keys of the Center and T-bar panels.

To do simple tracking:
– Use the TRACK FWD, TRACK REV, and STOP TRACK soft buttons on the left side of the Center panel.
– Press SHOW TRACK if you want to see the resulting motion path.
To turn tracking on and off for Pan, Tilt, Zoom, and Rotate:

1. Press the P/T/Z/R ENABLE soft key. The middle four soft keys of the Center panel change to display PAN ON/OFF, TILT ON/OFF, ZOOM ON/OFF, and ROTATE ON/OFF.
2. Use these buttons to toggle any of these checkboxes on or off, then press BACK to go back to the other tracking controls.

To interpolate between two separately tracked ranges of frames:

1. Use the transport controls to move the playhead to the first frame you want to place a mark, and press MARK. A Viewer Mark appears on the tracking bar, identifying either the beginning or the end of the gap in that clip's motion tracking data.
2. If necessary, use the transport controls to move the playhead to the second frame where you want to place a mark, and press MARK. A second Viewer Mark appears in the tracking bar, identifying both the beginning and end of the gap in that clip's motion tracking data.
3. To perform the interpolation, do one of the following:
   – If you marked both the first and last tracked frames that surround a gap in tracking data, press the INTRPLT BETWEEN soft key.
   – If you marked the last tracked frame in the first half of the clip, then use the transport controls to move the playhead to the first tracked frame of the second half of the clip and press the INTRPLT REV soft key.
   – If you marked the first tracked frame in the second half of the clip, then use the transport controls to move the playhead to the last tracked frame of the first half of the clip and press the INTRPLT FWD soft key.

To move the playhead to different “cue” frames:

– Press the CUE START, CUE LOWER, CUE UPPER, or CUE END soft keys on the T-bar panel.

To use Interactive mode:

1. Press the INTERACTIVE soft key at the left of the Center panel. Additional button controls appear on the soft keys of the Transport panel, including INSERT (POINTS), DELETE (POINTS), CLEAR (POINTS), and SET POINT.
2. Do one of the following:
   – To eliminate all tracking points, press the CLEAR soft key.
   – To add a single tracking point, press CURSOR (above the fourth trackball), use the fourth trackball to position the onscreen cursor over the feature you’d like to add a tracking point to, and then press the SET POINT soft key.
   – To eliminate a range of tracking points in order to prevent the tracking of an undesirable feature, use the mouse to draw a bounding box around the tracking points you want to remove, and press the DELETE soft key.
   – To add a range of tracking points to a specific feature, use the mouse to draw a bounding box around the feature you want to track, and press the INSERT soft key.
3. Use the TRACK FWD, TRACK REV, and STOP TRACK soft buttons on the left side of the Center panel to perform the necessary tracking.
4. Press the INTERACTIVE soft key again to leave Interactive mode.
This chapter covers the Noise Reduction and Motion Blur effects found in the Motion Effects palette. It also goes into detail about the Blur, Sharpen, and Mist features of the Blur palette.

## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motion Effects Palette</td>
<td>2989</td>
</tr>
<tr>
<td>Noise Reduction Controls</td>
<td>2989</td>
</tr>
<tr>
<td>Limiting Noise Reduction in Useful Ways</td>
<td>2993</td>
</tr>
<tr>
<td>Controlling the Order of Operations for Noise Reduction</td>
<td>2993</td>
</tr>
<tr>
<td>Motion Blur</td>
<td>2994</td>
</tr>
<tr>
<td>The Blur Palette</td>
<td>2994</td>
</tr>
<tr>
<td>Blur</td>
<td>2995</td>
</tr>
<tr>
<td>Sharpen</td>
<td>2996</td>
</tr>
<tr>
<td>Mist</td>
<td>2997</td>
</tr>
</tbody>
</table>
Motion Effects Palette

The Motion Effects palette (only available in the Studio version) contains two sets of controls for applying optical-flow-calculated effects to clips in your program. These include enhanced Spatial and Temporal noise reduction, and motion-estimated artificial motion blur.

Noise Reduction Controls

Two sets of parameters let you apply GPU-accelerated Temporal and/or Spatial noise reduction that’s designed to let you subdue noise in problematic clips, in close to real time on workstations with appropriate processing power. Both methods of noise reduction can be used separately or together, in varying amounts depending on the needs of the particular material you’re working on. Furthermore, each set of controls is highly customizable, allowing for varying amounts of noise reduction to the chroma and luma of an image, as well as numerous options for how to apply this noise reduction.

Temporal NR Controls

The Temporal NR controls analyze images across multiple frames in order to isolate noise from detail. Motion estimation settings let you exclude moving subjects from this operation in order to prevent unwanted motion artifacts.

– **Number of Frames:** The number of frames you want DaVinci Resolve to average in order to separate detail from the noise. You can choose between 0 and 5 frames. 0 applies no frame averaging, higher values apply more frame averaging, at the expense of being significantly more computationally intensive the higher a value you use. Also, a higher frame setting will yield a better analysis, but may yield unwanted artifacts if there are fast-moving images in the frame. A value of 1 may yield better results for fast-moving images. If you need to use higher frame values but you see artifacts, you can also try adjusting the Motion Threshold to fix the issue.

– **Motion Est. Type:** Picks the method DaVinci Resolve uses to detect motion in the image. The default, Faster, is less processor intensive, but less accurate. Choosing Better can effectively exclude motion more accurately, but is more processor intensive. None lets you disable motion estimation altogether, with the result being the application of Temporal NR to the entire image.

– **Motion Range:** Three settings, Small, Medium, and Large, let you set the speed of motion that Motion Estimation should expect to exclude. A Small setting assumes slow-moving subjects with little or no motion blur, allowing Temporal NR to affect more of the image at a given Motion Threshold setting. A Large setting assumes fast motion with blur occupying a larger area of the image, which excludes more of the image from Temporal NR at the same Motion Threshold setting. Choose the setting that gives you the best compromise between a reduction in noise and the introduction of motion artifacts when adjusting the Motion Threshold parameter.
- **Luma Threshold:** Lets you determine how much or how little Temporal NR to apply to the luma component of the image. The range is 0–100, where 0 applies no noise reduction at all, and 100 is the maximum amount. Too high a setting may eliminate fine detail from the image.

- **Chroma Threshold:** Lets you determine how much or how little Temporal NR to apply to the chroma component of the image. The range is 0–100, where 0 applies no noise reduction at all, and 100 is the maximum amount. Too high a setting may eliminate fine color detail from the image, although you may find you can raise the Chroma Threshold higher than the Luma Threshold with less noticeable artfacting.

- **Luma/Chroma Threshold ganging:** Ordinarily, the Luma and Chroma Threshold parameters are ganged together so that adjusting one adjusts both. However, you can ungang these parameters in order to adjust different amounts of noise reduction to each component of the image, depending on where the noise happens to be worst.

- **Motion Threshold:** Defines the threshold separating which moving pixels are in motion (above this threshold) versus which moving pixels are static (below this threshold). Using Motion Estimation, Temporal Noise Reduction is not applied to regions of the image that fall above this threshold, in order to prevent motion artifacts by not applying frame-averaging to parts of the image that are in motion. Lower values omit more of the image from Temporal NR by considering more subtle movements. Higher values apply Temporal NR to more of the image by requiring faster motion for exclusion. You can choose between 0 and 100, where 0 applies Temporal NR to no pixels, and 100 applies Temporal NR to all pixels. The default value is 50, which is a suitable compromise for many clips. Be aware that if you set too high a Motion Threshold, you may see artifacts in moving parts of the image.

- **NR Blend:** Lets you dissolve between the image as it’s being affected by the Temporal NR parameters (at 0.0) and the image with no noise reduction at all (100.0). This parameter lets you easily split the difference when using aggressive temporal noise reduction.

**Spatial NR Controls**

The Spatial NR controls let you smooth out regions of high-frequency noise throughout the image, while attempting to avoid softening by preserving detail. It’s effective for reducing noise that Temporal NR can’t.

- **Mode:** The Mode drop-down lets you switch Spatial NR between three different algorithms. All three modes of operation use exactly the same controls, so you can switch between modes using the same settings to compare your results.

  - **Faster:** Uses a computationally lightweight method of noise reduction that’s good at lower settings, but may produce artifacts when applied at higher values.

  - **Better:** Switches the Spatial NR controls to use a higher quality algorithm that produces greatly superior results to Faster, at the expense of being more processor intensive to render, as well as not allowing you to decouple the Luma and Chroma Threshold sliders for individual adjustments to each color component.

  - **Enhanced:** Does a significantly better job of preserving image sharpness and detail when raising the Spatial Threshold sliders to eliminate noise. This improvement is particularly apparent when the Spatial Threshold sliders are raised to high values (what constitutes “high” varies with the image you’re working on). At lower values, the improvement may be more subtle when compared to the “Better” mode, which is less processor intensive than the computationally expensive “Enhanced” setting. Additionally, “Enhanced” lets you decouple the Luma and Chroma threshold sliders so you can add different amounts of noise reduction to each color component, as the image requires.

- **Radius:** Options include Large, Medium, and Small. A smaller radius offers greater real time performance, and can provide good quality when using low Luma and Chroma Threshold values. However, you may see more aliasing in regions of detail when using low NR Threshold values.
Setting Radius to be progressively larger results in higher quality within areas of greater visual
detail at high Luma and Chroma Threshold values, at the expense of slower performance. An NR
Radius of Medium should provide suitable quality for most images when using medium NR
Threshold settings. As with many operations, there’s an adjustable tradeoff between quality
and speed.

– **Luma Threshold**: Lets you determine how much or how little noise reduction to apply to the luma
component of the image. The range is 0–100, where 0 applies no noise reduction at all, and 100 is
the maximum amount. Too high a setting may eliminate fine detail from the image.

– **Chroma Threshold**: Lets you determine how much or how little noise reduction to apply to
the chroma component of the image by smoothing out regions of high-frequency noise while
attempting to preserve the sharpness of significant edge details. The range is 0–100, where 0
applies no noise reduction at all, and 100 is the maximum amount. Too high a setting may eliminate
fine color detail from the image, although you may find you can raise the Chroma Threshold higher
than the Luma Threshold with less noticeable artifacting.

– **Luma/Chroma Threshold ganging**: Ordinarily, the Luma and Chroma Threshold parameters are
ganged together so that adjusting one adjusts both. However, you can ungang these parameters
in order to adjust different amounts of noise reduction to each component of the image. For
example, if an image softens too much at a certain level of noise reduction, but you find there’s
more color speckling than there is luma noise, you can lower the Luma Threshold to preserve
detail while raising the Chroma Threshold to eliminate color noise.

– **NR Blend**: Lets you dissolve between the image as it’s being affected by the Spatial
NR parameters (at 0.0) and the image with no noise reduction at all (100.0). This parameter lets you
easily split the difference when using aggressive spatial noise reduction.

Using Noise Reduction

The following procedure suggests a method of using the Noise Reduction (NR) parameters to achieve
a controlled result.

**Applying noise reduction to an image:**

1. **Enable Temporal NR** by choosing 1 to 5 frames from the Number of Frames drop-down menu.
   Keep in mind that more frames dramatically increase the render time of this effect, while it may or
   may not significantly improve the result, depending on your material.

2. **Choose options from the Motion Est. Type and Motion Range drop-down menus corresponding
to how much motion is in the image. If there’s a lot of motion, you may need to choose Better and
Large. If there’s not very much motion, lesser settings may suffice.**

3. **With Luma and Chroma Threshold linked, slowly raise either parameter until you just start to see
a reduction in noise within the nonmoving areas of the image, then make smaller adjustments to
determine the maximum amount of Temporal NR you can add without creating motion artifacts, or
overly softening image detail you want to preserve.**

4. **If there’s obviously more chroma than luma noise in the image, you can disable Luma/Chroma
linking at a satisfactory level of luma noise reduction, and then raise the Chroma Threshold to
apply more aggressive Temporal NR to address color speckling in the picture.**

5. **If you’re not satisfied with the tradeoff between the maximum possible threshold of noise
reduction and the prevention of motion artifacts, you may want to adjust the Motion Threshold
setting, lowering it to omit more of the motion from the noise reduction operation, or raising it
to include more motion. If you’re still not satisfied, you can also try better Motion Est. Type and
Motion Range settings.**
Keep in mind that the strength of Temporal NR is to reduce noise in unmoving parts of the image. When you’ve achieve the best tradeoff between noise reduction in the still areas and avoidance of motion artifacts in the moving areas of the image, then it’s time to turn to Spatial NR to further eliminate noise throughout the rest of the picture.

6 Enable Spatial NR by raising either the Luma or Chroma Threshold parameters, which are linked by default, until you strike a suitable balance between the reduction of noise, and an unwanted increase in image softness.

7 It’s recommended to choose the Enhanced option from the Spatial NR mode drop-down, as it will yield the best possible results. However, this can be processor-intensive, so if you need better real-time performance, you can switch the mode to Faster and compare results.

8 If there’s obviously more chroma than luma noise in the image, you can disable Luma/Chroma linking at a satisfactory level of luma noise reduction, and then raise the Chroma Threshold to apply more aggressive Spatial NR to address color speckling in the picture.

9 If you’ve had to use a high Spatial NR Luma or Chroma Threshold setting to reduce noise visibly, and areas of detail look a bit chunky or aliased, you can choose a larger setting from the Radius drop-down menu to enable a more detailed analysis of the scene.

This will result in higher visual quality, but larger NR Radius settings are more processor intensive, and may reduce real time performance if you don’t have adequate GPU resources available to your system.

10 If you’ve found suitable noise reduction settings, but the result is too aggressive and makes the image appear too processed, you can try raising the Spatial NR and/or Temporal NR Blend parameters to fade between the noise reduction added by each set of controls, and the image as it was before you added noise reduction.
Try Applying Temporal NR First, then Applying Spatial NR

Because Temporal NR analyzes multiple frames for its noise isolation, it tends to be better at preserving detail accurately in regions of the image where there’s little motion. If you try applying Temporal NR first and get a successful result, even if only in part of the image, you may reduce how much Spatial NR you have to apply, thus improving the overall quality of your final result.

Keep in mind that while Temporal NR does a great job in unmoving parts of an image but is less effective when dealing with subjects in motion, Spatial NR is able to reduce noise everywhere in the frame falling below its threshold, even when there’s motion. Ultimately, a combination of the two is almost always going to be a winning combination.

Spatial NR Radius, How Large Should You Go?

Larger NR Radius settings can dramatically improve the quality of high-detail regions in shots where you’re using aggressive Spatial noise reduction, but it’s not necessary to always jump to the large Radius setting, which provides the highest precision. In many cases, when evaluating an image that you’re applying noise reduction to, you may not actually be able to perceive the additional quality, and you’ll waste processing time on an unnecessary level of correction.

It’s a good idea to make sure that you’re evaluating the full-frame image on a large enough display to see the noise you’re working on within the viewing context of the intended audience. Zooming really far into a clip while applying noise reduction may encourage you to use higher quality settings than are necessary, because an excessively enlarged detail of an image lets you see subtle changes that you wouldn’t notice at actual size.

Limiting Noise Reduction in Useful Ways

As with any other correction in the Color page, noise reduction can be limited using HSL Qualification or Power Windows. This means you can focus your efforts on reducing noise in the most problematic areas of an image (for example, in shadows and background regions), while sparing elements that you don’t want to affect (such as faces or better-lit areas of the image).

Furthermore, you can use Spatial NR in lieu of Blur operations to perform a subtler form of complexion smoothing, using the HSL qualifier or a window to isolate an actor’s skin tone for targeted noise reduction.

Controlling the Order of Operations for Noise Reduction

You can apply noise reduction at any point in your image processing tree using a dedicated node. If you have an image with noise that you think might be enhanced by whatever corrections you need to make (increasing the contrast of underexposed clips often increases whatever noise is within an image), there are two approaches to noise reduction:

– **Apply noise reduction at the beginning of a node tree:** This lets you pre-emptively eliminate any noise before it becomes a problem as a result of whatever adjustments you’re planning to make. The result can be smoother, but you may also notice that the edge detail within the image is a bit softer.

– **Apply noise reduction at the end of a node tree:** The alternative is to make your adjustments first, and then apply noise reduction in a separate node afterwards. In this case, you may find that the noise reduced regions of the image aren’t quite as smooth, however the edge detail within the image may be visibly sharper as a result.

– **Apply noise reduction to only one color channel of an image:** Using the Splitter/Combiner nodes, you can also apply noise reduction to only one color component of an image. If you’re grading a video clip with a noisy Blue channel, this can be a way to focus noise reduction where it’s needed. Isolating a single color channel for noise reduction is also possible using the Channels selection when right-clicking a node. By selecting the specific channel numbers in this node corresponding to your color space (RGB, YUV, LAB, etc.), you can limit the noise reduction operation to the appropriate channels only.
Neither result is universally better or worse than the other. Which is preferable depends on the image you’re working on, and the type of result you’re looking for (you might prefer some shots to be a bit softer, while you’d like other shots to be a bit sharper). The real point is that the node-based image processing of DaVinci Resolve lets you choose which technique works best for you.

**NOTE:** If you apply noise reduction and make color adjustments within the same node, noise reduction is processed first, followed by color adjustments.

**Using Noise Reduction Controls with the DaVinci Control Panel**
- All three Noise Reduction controls are available via knobs on the PRIMARIES, NOISE REDUCTION control group on the Center panel.

**To open the Noise Reduction controls on the DaVinci control panel:**
- Press the PRIMARIES or MAIN soft key on the Center panel, whichever is visible (depending on which control group is currently displayed).

**Motion Blur**

Motion Blur settings use optical-flow based motion estimation to add artificial motion blur to clips that have none. This can be useful in cases where a program was shot using a fast shutter speed, and you later decide that the resulting video has too much strobing. By analyzing the motion within a clip, the Motion Blur settings can selectively apply blurring to the image based on the speed and direction of each moving element within the scene.

**Motion Blur controls**

Three parameters let you set how much motion blur to add, and at what quality:
- **Motion Est. Type:** A setting of Better provides more accurate pixel mapping at the expense of being more processor intensive. Faster provides a more approximate result, but is less processor intensive.
- **Motion Range:** Determines what speed of motion to consider when defining regions being blurred.
- **Motion Blur:** Raise this parameter to add more motion blur to the image, lower it to add less. The range is 0–100, where 0 applies no motion blur, and 100 applies maximum motion blur.

**The Blur Palette**

The Blur palette has three different modes of operation—blur, sharpen, and mist. While the functionality of the Blur and Sharpen modes somewhat overlap, each mode provides dedicated controls that the other ones lack.

As with virtually everything else in the Color page, the operations performed in the Blur palette can be limited as a secondary operation using HSL Qualifiers, Windows, or Imported mattes, which makes it easy to apply these effects to specific portions of the image.
Many of the controls in the Blur palette consist of three ganged sliders, one for red, one for green, and one for blue.

By default, these ganged sliders move together as one, resulting in each color channel of the image being equally affected. A small white button to the left of each control’s name lets you ungang these sliders, in order to apply degrees of adjustment to individual color channels.

**Blur**

The default mode, Blur lets you apply an exceptionally high-quality Gaussian blur, or another equally high-quality sharpening operation to your image. This mode of operation has the simplest controls.

Two sets of linked parameters let you adjust the extent and directionality of blur or sharpening. Which is applied depends on the direction in which you adjust the Radius control.

Blurr Radius controls are ganged by default, but can be un ganged

- **Radius:** This is the primary control for adding blur or sharpening. The default value of 0.50 results in no effect being applied to the image. Raising the radius slider increases blur, while lowering the radius increases sharpness, with a minimum value of 0.00 providing maximum sharpness.

  **TIP:** If you raise the Radius slider all the way to 1.00 and the image isn’t blurred enough, add another node and use it to add another blur operation. You can also use the scroll wheel on your mouse while hovering over one of the bars to increase the radius.

- **H/V Ratio:** Lets you add directionality to the current operation. At the default value of 0.50, the image is affected in both the horizontal and vertical directions equally. Raising H/V Ratio makes the effect increasingly directional along the horizontal axis, while lowering makes the effect increasingly directional along the vertical axis.

**To adjust the Blur controls using the DaVinci control panel:**

1. Press the VECTORS button on the T-bar panel, or the VECTORS soft key on the Trackball's main page.
2. Use the BLUR AMOUNT and H/V RATIO knobs to add either blur or sharpening.
3. When you’re finished, press the PRIMARIES soft key to return to the Center panel’s main page.
Sharpen

While the Blur controls also let you apply sharpening simply by lowering, rather than raising, the Radius sliders, the actual Sharpen mode provides additional controls specifically for tailoring sharpening operations.

Sharpening with Coring Softness and Level

– **Radius**: This is the primary control for adding blur or sharpening. The default value of 0.50 results in no effect being applied to the image. Raising the radius slider increases blur, to a maximum value of 1.00. Lowering the radius increases sharpness, with a minimum value of 0.00 providing maximum sharpness.

– **H/V Ratio**: Lets you add directionality to the current operation. At the default value of 0.50, the image is affected in both the horizontal and vertical directions equally. Raising H/V Ratio makes the effect increasingly directional along the horizontal axis, while lowering makes the effect increasingly directional along the vertical axis.

– **Scaling**: Multiplies the amount of scaling being applied by the Radius control for sharpening operations. The scaling parameter has no effect if Radius is set to 0.50 or above for blur effects.

The Coring Softness and Level parameters work together to let you limit sharpening to only the most detailed areas of the picture that would most benefit from it, based on a threshold of image detail that you define using the Level and Softness parameters.

– **Level**: The first slider you should use. Raising this value sets the threshold at which image detail is omitted from the sharpening operation. The default setting of 0 sets the threshold low enough to sharpen the entire image. Raising Level gradually omits low-detail areas of the image, which results in sharpening being restricted to well-defined outlines.

– **Coring Softness**: After you’ve set the Level slider to an appropriate amount, raising Coring Softness blends the border between parts of the image that are sharpened and parts of the image that are left alone.

To adjust the Sharpening controls using the DaVinci control panel:

1. Press the VECTORS button on the T-bar panel, or the VECTORS soft key on the Center panel’s main page.
2. On the Center panel, press the IMAGE MODE soft key repeatedly to cycle to the RESOLVE IMAGE SHARPENING controls.
3. Use the SHARP AMOUNT, SCALING, LEVELS, and SOFTNESS knobs to create the desired sharpening effect.
4. When you’re finished, press the PRIMARIES soft key to return to the Center panel’s main page.
**Mist**

The Mist mode lets you combine blur and sharpen operations in such a way as to create effects similar to those achieved via “Vaseline on the lens” or Pro-Mist optical filters.

Unlike the Blur or Sharpen modes, where the Radius sliders provide immediate access to the desired effect, the Mist mode requires you to lower the Radius and Mix sliders together to get a desirable result. By varying the amounts of Radius and Mix, you can create many variations on the mist effect.

- **Radius:** When creating a Mist effect, you first need to lower Radius to sharpen the image. This operation then combines with a lowering of the Mix parameter to provide the combination of detail and blurring that results in a mist effect.

- **H/V Ratio:** Lets you add directionality to the current operation. At the default value of 0.50, the image is affected in both the horizontal and vertical directions equally. Raising H/V Ratio makes the effect increasingly directional along the horizontal axis, while lowering makes the effect increasingly directional along the vertical axis.

- **Scaling:** Multiplies the amount of scaling being applied by the Radius control, and lets you intensify a mist effect beyond the Radius slider’s ordinary range. The scaling parameter has no effect if Radius is set to 0.50 or above for blur effects.

- **Mix:** After you sharpen the image using the Radius slider, decreasing the Mix parameter adds a superimposed blur that mixes with the high-detail areas of the picture to create the mist effect.

**To adjust the Mist controls using the DaVinci control panel:**

1. Press the VECTORS button on the T-bar panel, or the VECTORS soft key on the Center panel’s main page.

2. On the Center panel, press the IMAGE MODE soft key repeatedly to cycle to the RESOLVE MIST EFFECT controls.

3. Use the RADIUS, H/V RATIO, SCALING, and MIX knobs to create the desired mist effect.

4. When you’re finished, press the PRIMARIES soft key to return to the Center panel’s main page.
Dust Removal

This chapter shows how you can use the legacy Dust Removal feature that’s built into the Color page. There’s also a pair of Resolve FX plug-ins: “Automatic Dirt Removal” and “Dust Buster,” found in the Revival category of the Resolve FX plug-ins. For more information on those, see Chapter 160, “Resolve FX Revival.”

Contents

Introduction to Dust Removal 2999
Dirt and ROI Settings Parameters 3000
Algorithms for Dirt and Dust Removal 3000
Introduction to Dust Removal

The interactive Dirt and Dust Removal tool provides an interface for dustbusting right from within DaVinci Resolve. This is a raster-based effect, and results in a duplicate set of “dustbusted” media being created within a hidden subdirectory.

If, at any point, you’re unsatisfied with the adjustment you’ve made, you need only use the undo command to return the clip you’re working on to its prior state.

**IMPORTANT**

The Dirt and Dust Removal tool only works with DPX image sequences. Media in a raw, ProRes, or DNxHD format should use the Dust Buster Resolve FX filter instead, or be converted to a DPX image sequence before it can be operated on with this tool.

To use the Dirt and Dust Removal tool:

– Click the Onscreen Control drop-down menu at the bottom left of the Viewer, and choose Dust Removal.

To open the Dirt and Dust Removal tool setup options:

– Right-click the Dirt and Dust Removal icon showing in the Onscreen Control drop-down to open the setup window.
Dirt and ROI Settings Parameters

In the Dirt and ROI Settings window, there are a number of parameters that you can use to optimize this tool for the particular problem you’re trying to solve.

- **Algorithm:** The Algorithm drop-down menu lets you select the method of filtration to use when painting out dirt or dust. Different options provide different methods for replacing the problem pixels with image data copied from other frames in time, or from other regions of the current frame. You’ll want to choose an option that works best for the type of camera and subject motion happening within the clip you need to clean. For more information on the advantages of each algorithm, see the next section.

- **Aggression:** Increase or decrease the Aggression and Blend sliders depending on the degree of correction you want to apply.

- **Blend:** Sets the % of the original image to be feathered at the edges of the repair.

- **Optimize:** Turning this option on provides better-looking results, at the expense of increased processing time.

- **ROI Mode:** Determines whether a correction is applied with a single click, or via a paint stroke. There are three options.
  - **Click and Clean:** Applies a correction with one click, and is fast to use on small dust spots.
  - **Draw and Clean:** Lets you “paint” over a larger dirty area with the mouse or a pen, with the correction being applied at the conclusion of your paint stroke.
  - **CNC Size:** Defines the width of the “brush” that’s used to paint out dirt and dust.

Algorithms for Dirt and Dust Removal

There are six algorithms you can choose from that determine how the pixels you paint over are automatically replaced.

- **Auto-temporal –/+ 1:** When an ROI is drawn, the previous frame, the next frame and the current frame will all be used for analysis. The best of these 3 will be automatically selected and used for removing the dirt in the current frame.

- **Auto-temporal –/+ 2:** This is the same as the above, but the frames used instead are the current frame, previous-to-previous frame (i.e., 2 frames back), and next-to-next frame (i.e., 2 frames forward). Therefore, if the ROI is drawn on frame 100, frame 98, frame 100, and frame 102 will be used for analysis. The best of these 3 will be used for removing the dirt in the current frame. The advantage of this selection is that it will avoid the appearance of frozen grain, which may be possible in case of dirt against a stationary background.

- **Temporal –/+ 1:** If the ROI is drawn by dragging the mouse from left to right, the next frame will be used for motion-compensated dirt removal. If the ROI is drawn by dragging the mouse from right to left, the previous frame will be used.

- **Temporal –/+ 2:** If the ROI is drawn by dragging the mouse from left to right, the next-to-next frame will be used for motion-compensated dirt removal. If the ROI is drawn by dragging the mouse from right to left, the previous-to-previous frame will be used.

- **Spatial:** In case of fast or blurred motion, using the previous or next frames may give unsatisfactory results. In this case, the same frame itself can be used for removing the dirt. This will use surrounding information in the current frame to remove the dirt.

- **Median:** The Median filter performs a blending of the pixels, smoothing out the region. Use this when other options do not replace the image, or when there is no support information in which to reconstruct the original. Using small boxes will produce better results.
PART 12

Resolve FX
Overview
Chapter 153

Resolve FX

This section provides detailed explanations for each Resolve FX filter that’s available on the Cut, Edit, Fusion, and Color pages.

For more information on how to apply and adjust Resolve FX on the Cut page, see Chapter 30, “Video and Audio Effects in the Cut Page.”

For more information on how to apply and adjust Resolve FX on the Edit page, see Chapter 48, “Editing, Adding, and Copying Effects and Filters.”

For more information on how to apply and adjust Resolve FX on the Fusion page, see Chapter 85, “Using Open FX, Resolve FX, and Fuse Plug-Ins.”

For more information on how to apply and adjust Resolve FX on the Color page, see Chapter 149, “Using Open FX and Resolve FX.”

Contents

Catalogue of Resolve FX Filters 3003
Catalogue of Resolve FX Filters

DaVinci Resolve comes with a set of Resolve FX filters, many of which have been optimized for real-time playback. These are located within their own category in the Effects Library of the Cut, Edit, and Fusion pages, and in the Open FX browser of the Color page. These effects (or filters) work just like any other Open FX plug-in.

Resolve FX are shown as icons depicting each specific filter. Hovering the mouse pointer over the icon previews the filter in the Viewer, and moving the mouse pointer along the icon previews the filter over the length of the clip.

In addition to the different parameters built into each filter, every single Resolve FX filter has a Blend parameter that mixes that filter’s effect against the original image. Each filter’s Blend parameter appears at the bottom of that filter’s settings.
Chapter 154

Resolve FX Blur

The plug-ins in this category offer a wider variety of different blur methods than those found in the Blur palette.

Contents

Box Blur 3005
Directional Blur 3005
Gaussian Blur 3005
Lens Blur (Studio Version Only) 3006
Shape 3006
Speed 3007
Controls 3007
Mosaic Blur 3007
Radial Blur 3008
Zoom Blur 3008
Box Blur

A variable quality blur that ranges from very low quality to very soft.

- **Horizontal and Vertical Strength**: These sliders let you adjust the width and height of blur.
- **Gang**: This checkbox lets you adjust these parameters together or separately.
- **Number of Iterations**: Controls how smooth the resulting blur is, with 0 being the lowest and most “boxy” level of quality and 1 being the highest and smoothest level of quality. At low iteration values, box blurs can appear somewhat similar to lens blurs.
- **Border Type**: Lets you choose how the edges of the image are affected by this blur, options include Black, Replicate, Reflect, and Wrap Around.

Directional Blur

A blur that’s constrained to a single angle.

- **Blur Strength**: How much blur you want.
- **Blur Angle**: The direction of blur.
- **Blur Type**: When Blur Type is set to Realistic, the blur effect emulates a photographic motion blur. When set to Stylized, the blur effect is a simple and smooth digital blur.
- **Symmetric Blur**: When the Symmetric checkbox is turned on, the blur effect appears to be created from both directions, with the result being more of a double-image that’s blurring along the blur angle, simulating motion blur in a camera. When off, the blur effect appears to be moving in a single direction, from the original position out along the blur angle.
- **Border Type**: Lets you choose how the edges of the image are affected by this blur; options include Black, Replicate, Reflect, and Wrap Around.

Gaussian Blur

Provides a smooth blur that resembles looking at the image through semi-opaque glass, reducing detail and noise.

- **Horizontal and Vertical Strength**: Two sliders let you adjust the Horizontal and Vertical Strength independently.
- **Gang**: This checkbox lets you keep the Horizontal and Vertical Strength values ganged together.
- **Border Type**: Lets you choose how the edges of the image are affected by this blur; options include Black, Replicate, Reflect, and Wrap Around.
Lens Blur (Studio Version Only)

A high-quality simulation of optical lens blurring. Adjustable parameters let you achieve different kinds of “bokeh” effects, which are similar to those produced by different combinations of aperture design and lens spherical aberration corrections that affect the “circle of confusion” that creates visible shapes in areas of the picture with pinpoint highlights.

Shape

The Shape group lets you choose what shape of aperture to simulate and affects the shape of the bokeh in this effect.

- **Shape Type**: Lets you choose what type of apertures you want to use. There are three options:
  - **Real Apertures**: Lets you choose a realistic option from the Aperture Shape pop-up menu below, with which to influence the shape of the bokeh effect. Aperture Shape options include Triangle, Square, Pentagon, Hexagon, Heptagon, or Octagon shaped aperture.
  - **Creative**: Lets you choose a more fanciful option from the Aperture Shape pop-up menu below, with which to influence the shape of the bokeh effect. These options simulate the kind of bokeh you could realistically achieve by placing a black-out filter with a custom shaped hole in the center in front of a lens. Aperture Shape options include Heart, Star, Starfish, Starburst, Petals, Lip, Eye, Droplet, and Leaf.
  - **External Input**: Uses any arbitrary graphic with a (preferably small) white shape against a black background to influence the shape of the bokeh effect. This shape must be a graphic or matte clip that’s added to the Node Editor and can be connected in one of two ways. If the plug-in is dragged onto an ordinary corrector node, then you must use the Add OFX Input command to expose an RGB input with which to connect the image. If you’ve added the plug-in as a self-contained OFX node (named “Lens Blur”), then you can attach the image to the second RGB input of the Lens Blur node.

- **Aperture Shape**: Provides different options for aperture shapes that influence the shape of this plug-in’s simulated bokeh blur effect.
- **Preview Shape**: This checkbox lets you see the actual shape you’ve selected to use.
Speed
The Speed Options group lets you adjust the quality/speed tradeoff of this plug-in.

- **Quality**: Three options, Full, Half (Faster), and Quarter (Fast), let you choose a suitable tradeoff between image quality and plug-in performance.
- **Horizontal and Vertical Crop**: Crops the shape image being used to influence the bokeh to a smaller size, in the event the large size of the graphic is slowing things down and you can crop out extra black from the edges. You won’t notice a change to the result until you start cropping into the white part of the shape.

Controls
The parameters available from the Controls group change depending on the Shape Type you’ve selected.

- **Blur Size/Scale**: Adjusts the overall amount of blur. At higher values, the shape of bokeh can be more clearly seen.
- **Blade Curvature**: (Only available with Real and Creative Apertures) Lets you round off the edges of the Aperture Shape you selected.
- **Rotation**: Lets you adjust the angle the shape appears at.
- **Anamorphism**: Lets you adjust the aspect ratio of this effect in order to match the lens blur created by anamorphic lenses.
- **Chroma Shift**: Lets you simulate chromatic aberration within the blur effect.
- **Highlights**: Lets you adjust how the highlights of the image affect the blur, dilating or eroding the image more or less depending on how high Smooth Strength is.
- **Apodization**: (Only available with Real and Creative Apertures) A slider that lets you adjust the simulated “Airy disk” pattern in the defocused effect being generated. Dragging the slider to the left toward negative values accentuate concentric rings around the bokeh pattern that simulate the effects of optical diffraction and add a pattern to the result, while dragging this slider to the right introduces positive values that gradually filter the edges of the simulated bokeh pattern, resulting in a progressively smoother result.
- **Catadioptric**: (Only available with Real and Creative Apertures) A slider that lets you simulate the effect of a shaped mirror element in a Catadioptric telescope to “improve” focus within the defocused bokeh effect this plug-in produces. At higher and higher values, the underlying image becomes progressively less blurry, while still being distorted by the bokeh shape being used which results in soft image overlays, creating a very different kind of simulated optical defocusing effect.

Mosaic Blur
A simple, pixelated blur suitable for hiding the face of anonymous witnesses.

- **Pixel Frequency**: Lets you adjust the size of each pixel, thus determining the density and resolution of the resulting grid of pixels.
- **Smooth Strength**: Lets you blur the edges of adjacent pixels.
- **Border Type**: Lets you choose how the edges of the image are affected by this blur; options include Black, Replicate, Reflect, and Wrap Around.
Radial Blur

A blur effect that simulates the motion blur that would occur were the image spinning around its center point.

- **X and Y Position**: Lets you move the center of the blur.
- **Smooth Strength**: Adjusts how much blurring is applied.
- **Blur Type**: When Blur Type is set to Realistic, the blur effect emulates a photographic motion blur. When set to Stylized, the blur effect is a simple and smooth digital blur.
- **Blur Symmetry**: Three options are available.
  - **Symmetric**: The blur effect appears to be created in both directions, with the result being more of a double-image that’s blurring in an arc around the X/Y Position, simulating motion blur in a camera.
  - **Clockwise**: The blur effect appears to be moving in a single, clockwise direction.
  - **Anti-Clockwise**: The blur effect appears to be moving in a single, counter-clockwise direction.
- **Border Type**: Lets you choose how the edges of the image are affected by this blur; options include Black, Replicate, Reflect, and Wrap Around.

Zoom Blur

A blur effect that simulates the motion blur that would occur were a camera moving toward the image.

- **X and Y Position**: Lets you move the center of the blur.
- **Zoom Amount**: When Blur Type is set to Realistic, this slider becomes bi-directional. The center is 0, or no blur at all. Dragging to the right expands the blur effect outward from the position. Dragging to the left shrinks the image towards the Position, blurring outward from there.
- **Center Exclusion**: Controls the distance from the XY position that the Zoom Blur begins.
- **Blur Type**: When Blur Type is set to Realistic, the blur effect emulates a photographic motion blur. When set to Stylized, the blur effect is a simple and smooth digital blur.
- **Border Type**: Lets you choose how the edges of the image are affected by this blur; options include Black, Replicate, Reflect, and Wrap Around.
These plug-ins provide color processing methods that aren't available in any of the Color Page palettes of the Color page and include several color management tools that can be applied outside of Resolve Color Management (RCM).

Contents

- ACES Transform
- Chromatic Adaptation
- Color Compressor (Studio Version Only)
- Color Space Transform
- Color Space Transform
- Tone Mapping
- Gamut Mapping
- Advanced
- Color Stabilizer (Studio Version Only)
- Analysis Region
- Channels to Stabilize
- Captured Analysis Values
- Contrast Pop (Studio Version Only)
- DCTL (Studio Version Only)
- Dehaze (Studio Version Only)
- False Color (Studio Version Only)
- General
- Camera Model
- Color Bands
- Preprocessing
- Scale/Legend
- Global Blend
ACES Transform

Lets you perform the kind of color transforms that the ACES Input Device Transform and ACES Output Device Transform parameters of the Color Management panel do, without the need to have ACEScc or ACEScct enabled.

- **ACES Version**: When you’ve chosen one of the ACES color science options, this pop-up becomes available to let you choose which version of ACES you want to use. As of DaVinci Resolve 15, you can choose from ACES 1.0.3 or ACES 1.1 (the latest version).
- **Input Transform**: This pop-up menu lets you choose which IDT (Input Device Transform) to use to process the image. It presents the same options that are available in the Color Management panel of the Project Settings.
- **Output Transform**: This pop-up menu lets you choose an ODT (Output Device Transform) with which to transform the image data for monitoring on your calibrated display and when exporting a timeline in the Deliver page. It presents the same options that are available in the Color Management panel of the Project Settings.

For more information about the options available in these parameters, see Chapter 8, “Data Levels, Color Management, and ACES.”

**NOTE**: This plug-in does ACES transforms correctly using the transforms specified by the Academy, whereas the Color Transform plug-in does transforms to the ACES color space colorimetrically, which is not actually correct for ACES workflows.

Chromatic Adaptation

A Color category plug-in that lets you precisely transform an image that has been lit or processed assuming one specific color temperature to another user-selectable color temperature. This transformation alters the appearance of all colors in the image as perceived by the human vision system in the same way that a new illuminant would, whether that illuminant is a light in the environment being recorded or the color temperature of a display on which the image is shown. This plug-in is useful for performing specific color temperature transformations as part of color management workflows or for setting up precise color temperature adjustments as part of a creative grade.

You control this transformation by using pop-up menus to define the Illuminant Type of the source (typically the color temperature the camera was set to), and that of the target that you want to transform the image to. For both sets of controls, you can choose a Standard Illuminant from a list, a Color Temperature via a slider, or CIE 1931 xy coordinate values. This plug-in also takes into account the current color space and gamma of the clip, which default to the current Timeline Color Space.
This image transform is extremely precise because the image is first transformed from the Timeline Color Space to XYZ, and then it’s transformed to match the LMS (long, medium, short) color space that models the cone response of the human eye to colors lit by different illuminants.

The Method pop-up menu provides a variety of different transform methods to choose from, defaulting to CAT02. Each option in the Method pop-up menu uses different measurement datasets to create individual CAT matrixes to guide this transformation. As a result, each method prioritizes different levels of accuracy for different sets of colors. For example:

- CAT02 has a non-linear component that compensates for the tendency of extremely saturated blues to go purple, a typical weakness of other methods. It usually gives the best result for the widest variety of measured data sets and works best for emissive sources (displays) and dim viewing environments.

- Bradford Linear is also a commonly used method, albeit one in which extremely saturated blues will go purple during the transform. It works well for both emissive sources in dim environments and for reflective sources (theater screens) and dark environments.

- Von Kries is one of the oldest methods in common use, although it’s also one in which extremely saturated blues will go purple during the transform. This, as well as all other methods, are available if you need to match work done in another image processing application.

**NOTE:** Be aware that all methods listed will match neutral colors perfectly; the only differences lie in how different ranges of saturated color are transformed.

**Color Compressor (Studio Version Only)**

This filter lets you compress a range of colors toward a single target color. It works best when applied to similarly colored regions that have been isolated with a secondary qualifier or window. For example, if you’re adjusting an irregularly lit product such as a soda can or a dress that must have a very specific hue, you can isolate that item and use this filter to push the range of Hue, Saturation, and Luminance closer to the ideal color that’s identified using the color picker.

![Before/After] Using the Even plug-in to compress original range of hues of the jacket into a narrow “target” range within a secondary operation
– **Target Color**: A color control with an eyedropper button that you choose or sample a single set of Hue/Saturation/Luminance values you want to push all other colors toward.

– **Compress Hue, Compress Saturation, and Compress Luminance**: These sliders let you individually compress the range of colors you’re adjusting in the image to more and more closely match the image. At 0, no compression is applied, at 0.500 the original range of colors in the image have been adjusted to be halfway between their original values and the values of the Target Color, and at 1.000 the original range of colors has been set to be identical to the Target Color.

### Color Space Transform

Lets you perform the kind of color transforms that LUTs do, but instead of using lookup tables, this plug-in uses the same math used by Resolve Color Management (RCM) in order to do extremely clean color transforms without clipping.

### Color Space Transform

Exposes four pop-up menus that let you set an Input Colorspace, Input Gamma, Output Colorspace, and Output Gamma, in order to do controlled transforms from the Input settings to the Output settings, right within a grade. Resolve Color Management does not have to be enabled for you to use this filter.

### Tone Mapping

Tone Mapping Method lets you enable tone mapping to accommodate workflows where you need to transform one color space into another with a dramatically larger or smaller dynamic range by automating an expansion or contraction of image contrast in such a way as to give a pleasing result with no clipping.

– **None**: This setting disables Input DRT Tone Mapping. No tone mapping is applied to the Input to Timeline Color Space conversion at all, resulting in a simple 1:1 mapping to the Timeline Color Space.

– **Clip**: Hard clips all out-of-bounds values.

– **Simple**: Uses a simple curve to perform this transformation, compressing or expanding the highlights and/or shadows of the timeline dynamic range to better fit the output dynamic range. Note that the “Simple” option maps between approximately 5500 nits and 100 nits, so if you’re mapping from an HDR source with more than 5500 nits to an SDR destination there may still be some clipping of the highlights above 5500 nits.

– **Luminance Mapping**: Same as DaVinci, but more accurate when the Input Color Space of all your media is in a single standards-based color space, such as Rec. 709 or Rec. 2020.

– **DaVinci**: This option tone maps the transform with a smooth luminance roll-off in the shadows and highlights, and controlled desaturation of image values in the very brightest and darkest parts of the image. This setting is particularly useful for wide-gamut camera media and is a good setting to use when mixing media from different cameras.

– **Saturation Preserving**: This option has a smooth luminance roll-off in the shadows and highlights, but does so without desaturating dark shadows and bright highlights, so this is an effective option for colorists who like to push color harder. However, because over-saturation in the highlights of the image can look unnatural, two parameters are exposed to provide some user-adjustable automated desaturation.

– **Sat. Rolloff Start**: Lets you set a threshold, in nits (cd/m2), at which saturation will roll off along with highlight luminance. Beginning of the rolloff.

– **Sat. Rolloff Limit**: Lets you set a threshold, in nits (cd/m2), at which the image will be totally desaturated. End of the rolloff.
– **Use Custom Max Input / Output**: Checking these boxes and adjusting the slider below allows you to specify the minimum and maximum luminance of the input image in nits. Using these two sliders together, you can set which value from the Input Gamma is mapped to which value of the Output Gamma.

– **Adaptation**: Used to compensate for large differences in the viewer’s state of visual adaptation when viewing a bright image on an HDR display versus seeing that same image on an SDR display. For most “average” images this setting works best set between 0–10. However, when you’re converting very bright images (for example, a snow scene at noon), then using a higher value will yield more image detail within the highlights.

### Gamut Mapping

The Color Space Transform plug-in provides Gamut Mapping controls to accommodate workflows where you need to transform one color space into another that has a dramatically larger or smaller gamut. These controls are similar to those found in the Color Management panel of the Project Settings.

Tone Mapping Method lets you enable tone mapping to accommodate workflows where you need to transform one color space into another with a dramatically larger or smaller dynamic range by automating an expansion or contraction of image contrast in such a way as to give a pleasing result with no clipping. There are three options, None, Simple, and Luminance Mapping.

– Choosing None results in no tone mapping at all.

– Choosing “Simple” uses a simple curve to perform this transformation, compressing or expanding the highlights and/or shadows of the timeline dynamic range to better fit the output dynamic range. Note that the “Simple” option maps between approximately 5500 nits and 100 nits, so if you’re mapping from an HDR source with more than 5500 nits to an SDR destination there may still be some clipping of the highlights above 5500 nits.

– Choosing “Luminance Mapping” lets you use a customized curve operation to remap the gamma of the image and enables the Max. Input Luminance, Max. Output Luminance, and Avg. Input Luminance sliders.

– The Max. Input (nits) checkbox and slider lets you set the reference maximum Luminance value (in nits) that you want to remap to the value set by the Max. Output (nits) checkbox and slider, which governs the maximum luminance level of the Output color space (in nits). Using these two sliders together, you can set which value from the Input Gamma is mapped to which value of the Output Gamma.

– The Adaptation slider is designed to compensate for large differences in the viewer’s state of visual adaptation when viewing a bright image on an HDR display versus seeing that same image an SDR display. For most “average” images this setting works best set between 0–10. However, when you’re converting very bright images (for example, a snow scene at noon), then using a higher value will yield more image detail within the highlights.

– Choosing “Clip” hard clips all out-of-bounds values.

– Gamut Mapping Method accommodates workflows where you need to transform one color space into another with a dramatically larger or smaller gamut by helping to automate an expansion or contraction of image saturation in such a way as to give a pleasing and naturalistic result with no clipping.

– Choosing None results in no Gamut mapping at all.

– Choosing Saturation Mapping from this menu enables saturation mapping to fit the range of saturation values from the Input Color Space and Gamma into the Output Color Space and Gamma. It enables the Saturation Knee and Saturation Max. controls.
– The Saturation Knee slider sets the image level at which saturation mapping begins. Below this level, no remapping is applied. All saturation values from this level on up are remapped according to the Saturation Max. slider. A value of 1.0 is maximum saturation in the currently selected output color space.

– The Saturation Max slider sets the new maximum level to which you want to either raise or lower all saturation values that are above the Saturation Knee setting. A value of 1.0 is maximum saturation in the currently selected output color space.

– Choosing “Clip” hard clips all out-of-gamut values.

**NOTE:** While this plug-in has ACES settings, it does transforms to the ACES color space colormetrically, which is not actually correct for ACES workflows. For actual ACES workflows, use the ACES Transform plug-in, which uses transforms specified by the Academy.

### Advanced

This drop-down menu exposes the advanced features of the Color Space Transform effect.

– **Use white point adaptation:** Applies a chromatic adaptation transform to account for different white points between color spaces.

– Uncheck this box if you simply want to view the input color space’s white point unaltered in the output color space. For example, wanting to use a P3-D60 mastered clip inside a P3-D65 timeline for reference purposes.

– Check this box to apply the chromatic adaptation transform to convert the input white point to match the output color space’s white point. For example, wanting a P3-D60 mastered clip to cut in with other clips mastered in a P3-D65 timeline.

### Color Stabilizer (Studio Version Only)

Designed to deal with clips that have inconsistencies in exposure and color, caused by manual changes to a lens’ aperture setting or by a camera’s auto exposure settings causing unwanted changes to color and brightness in the middle of a shot. The Color Stabilizer plug-in analyzes a frame of the clip that represents the desired exposure and color, and automatically adjusts every other frame of the current clip to match the analyzed levels.

**IMPORTANT**

The Color Stabilizer gives you the best results with clips that don’t have clipped highlights. When used in the Color page, it’s recommended to grade the image to bring all the highlights you want somewhere at or under a value of 1023, and then apply the Color Stabilizer to a node after this adjustment.

There are two ways of using the Color Stabilizer:

– The easiest way is to choose Entire Frame from the Region For Analysis pop-up menu. Then, move the playhead in the Viewer to the frame that represents the contrast and color you want the entire clip to have, and click the Analyze This Frame. Now, if you play through the clip, changes in contrast and color should be gone. This method works best for clips where the inconsistency you’re trying to eliminate is fairly uniform, affecting the entire picture.
Another way is to choose Overlay Rectangle from the Region For Analysis pop-up menu. This causes an onscreen rectangle to appear that you can resize and position over a specific region you want to sample for the duration of the clip. If the selected feature you're analyzing is moving, then you can use the FX Tracker to track the subject so the selection box follows it (this is important for a consistent result). Once this is set up, move the playhead in the Viewer to the frame that represents the contrast and color you want the entire clip to have, and click the Analyze This Frame. Now, if you play through the clip, changes in contrast and color should be gone. This method works best for clips where there are parts of the picture that are supposed to have a change in brightness or color, such as when something moves into the frame, or a reflected highlight comes and goes because of the lighting scheme, at the same time as an otherwise undesirable change in contrast or color. You can use the selection box to specifically analyze the part of the frame that has the unwanted exposure change, while ignoring the desirable exposure change.

Depending on what option you choose from the Region for Analysis pop-up menu, different additional options appear.

**Analysis Region**

If you choose “Entire Frame” from the Region For Analysis pop-up, these controls don’t appear. A set of Source X/Y Position and Source Width/Height parameters let you transform the selection box that defines which part of the image is being analyzed.

**Channels to Stabilize**

Once you’ve analyzed the frame that represents the best contrast and color for that clip, the Channels to Stabilize controls let you choose how you want to handle making the correction. The What to Stabilize pop-up menu lets you choose between stabilizing White Balance and Brightness, or R, G, B Channels Separately.

- If you choose White Balance and Brightness, two checkboxes let you choose whether or not you want to include Stabilize White Balance and Stabilize Brightness independently from one another.
- If you choose R, G, B channels separately, three checkboxes appear letting for Stabilize Red, Green, and Blue Channel, so you can pick which particular channels you want to correct.

The “Stabilize Levels How” pop-up lets you choose how to make the correction, with options to Match Levels and Contrast, Lift to Consistent Level, Gain to Consistent Level, each of which uses a subtly different method to make the necessary correction, so if one method doesn’t work for the particular problem your clip is exhibiting, you can try the other methods to try and get a better result.

**Captured Analysis Values**

Once you’ve analyzed the frame, another set of parameters appear showing the captured analysis values upon which the automated correction is based, so that you can make manual adjustments if necessary to improve the result. The parameters that are shown depend on the option you chose from the What to Stabilize pop-up menu.

- If you chose White Balance and Brightness, then you’ll have a Normalized White Balance color control, and Low Level and High Level sliders.
- If you chose R, G, B Channels Separately, then you’ll have Red, Green, and Blue High and Low Level sliders.
**Contrast Pop** (Studio Version Only)

A more extreme and selective version of the Midtone Detail control found in the Color Wheels palette, designed to add either sharp high-contrast looks, or soft low-contrast looks to a selective portion of the tonal range of the image.

- **Detail Amount:** Lets you choose how much of this effect to apply. At 0, no effect is applied. At positive values progressively sharper contrast is added, while at negative values progressively softer low-contrast is applied.

- **Detail size:** Lets you choose which structures of the image are affected by this localized contrast adjustment, from smaller to larger.

- **Low and High Threshold:** These values let you define what range of image tonality is affected by this filter, allowing you to omit either shadows or highlights from this operation.

- **Softness:** Lets you soften the transition between the affected and unaffected areas of the image.

**DCTL** (Studio Version Only)

Lets you apply a DCTL wherever you can apply ResolveFX plug-ins. For more information on DCTLs and where they’re installed, see Chapter 191, “Creating DCTL LUTs.”

- **DCTL List:** A pop-up that lets you choose from the available DCTLs installed on your workstation.

- **Reload DCTL:** A button that lets you refresh the DCTL list pop-up if you’ve installed new DCTLs while DaVinci Resolve is running.

**Dehaze** (Studio Version Only)

Designed to let you make fast, selective adjustments to color and contrast to reduce the visible effects of smog, airlight, and haze in an image. This filter automatically generates a simulated depth matte which is used to apply more of this corrective color adjustment to faraway parts of the image that would be more affected by haze effects and less color adjustment to closeup parts of the image. However, the simulated depth mask is not going to be perfect, so additional controls exist to let you make adjustments to it to achieve a better result.

- **Dehaze Strength:** This slider applies a simultaneous color and contrast adjustment. Raising Dehaze Strength subtly increases contrast (especially in the shadows) while rebalancing color toward the complement of the currently selected Haze Color and selectively intensifying saturation. Lowering Dehaze Strength decreases contrast and rebalances color toward the selected Haze Color itself while selectively lowering saturation.

- **Haze Color:** A color control with an eyedropper button that you choose or sample the color of smog, airlight, or haze in an image that you want to minimize.

- **Display Depth:** Lets you view the simulated depth matte that’s being generated. It’s useful to turn this on before adjusting the Shadow and Highlight controls below.

- **Shadow:** This slider raises or lowers darkest parts of the simulated depth mask that defines the parts of the image that are supposedly farthest away.

- **Highlight:** This slider lets you raise or lower the lightest parts of the simulated depth mask that defines the parts of the image that are supposedly closest to us.
False Color (Studio Version Only)

False Color is a creative effect that can be used for replicating camera HUDs, infrared sensors, and custom posterization looks by defining a set number of colors for the clip. The color set can either match the False Color setting in a specific Blackmagic Design camera or be picked from a list of creative style presets. The presets can be modified by setting the number of colors used and defining the tonal range each color represents.

General

– **Plugin Mode:** This menu is used to switch between using a specific Blackmagic Design Camera’s False Color setting or accessing creative presets. When Specific Camera Model is chosen, the Camera Model section is displayed for selecting the camera and settings you want to use. When Creative is chosen, the Color bands section is displayed for choosing and customizing the preset.

Camera Model

The Camera Model controls are displayed when Specific Camera Model is chosen from the Plugin Model menu. These menus allow you to match the False Color from a camera configuration.

– **Camera:** Selects the exact Blackmagic Design camera sensor.
– **Camera Mode:** Selects the dynamic range setting.
– **ISO Level:** Sets the ISO or light sensitivity setting.

Color Bands

These controls are displayed when Creative is chosen from the Plugin Model menu. The Color Bands group of controls are used to select and modify the appearance of the False Color presets.

– **Camera:** Selects the exact Blackmagic Design camera sensor.
– **Camera Mode:** Selects the dynamic range setting.
– **ISO Level:** Sets the ISO or light sensitivity setting.
Preprocessing

This group of controls is used to apply tonal and blur processing to the image.

- **Blur**: Applies a blur filter to the False Color.
- **Black Level**: Increases or decreases the shadow range assigned to colors that fall lower on the False Color legend.
- **White Level**: Increases or decreases the highlight range assigned to colors that fall higher on the False Color legend.
- **Gamma**: Shifts the mid-tone range towards colors that fall lower or higher on the False Color legend.

Scale/Legend

This section is used to control the visibility and appearance of the False Color legend. The Legend is displayed to help viewers understand the color representation. Whenever you apply False Color, the Legend is generated and displayed. When you modify a preset, the Legend automatically updates to represent the new color scheme.

- **Show Scale**: Shows or hides the Legend on the left side of the frame.
- **Show Values**: Shows or hides numeric values on the Legend. These numeric values represent different scales based on the Value Style menu.
- **Show Labels**: Shows or hides data point labels on the Legend. The labels identify important data points along the tonal range, such as black clipping, white clipping, and middle gray.
- **Contrast**: Increases or decreases the transparency of the Legend’s background underlay.
- **Value Detail**: Increases or decreases the number of axis value labels displayed on the Legend.
- **Value Style**: This menu includes three options for the scale used for the Legend’s numeric values.
  - **Percentage**: Uses a percentage scale for the Legend, going from 0% at the bottom to 100% at the top.
  - **Hundredths**: Uses a Hundredths scale for the Legend, going from 0 at the bottom to 100 at the top.
  - **Normalized**: Uses a Normalized scale for the Legend, going from 0.0 at the bottom to 1.0 at the top.

Global Blend

- **Blend**: Lets you dissolve between the image with no False Color applied (0.0) and the image with False Color fully applied (1.0).

Flicker Addition

Why remove flicker with the Resolve FX Flicker Removal plug-in when you can add it instead? Found in the Resolve FX Transform category, the Flicker Addition plug-in adds rapidly animated exposure changes to make the image appear to flicker, creating animated effects that would be difficult to keyframe manually. When applied to an image in different ways, this plug-in can be used to simulate torchlight, firelight, light fixtures with old ballasts or frayed wiring, or any temporally unstable light source. For example, you could key only the highlights of a night-time image, and use Flicker Addition to affect those isolated highlights.

Two groups of controls let you control the quality of this flickering.
Main Controls
These controls let you choose how to apply the flicker, and its overall speed and intensity.

– **Flicker Type:** This pop-up menu lets you apply the flicker as a Lift, Gamma, Gain, or Vignette adjustment.

– **Range slider:** This lets you set how widely the flickering will vary.

– **Speed:** This lets you adjust how quickly the flickering is animated.

– **Smoothness:** This slider lets you adjust the temporal quality of the flickering, whether it changes abruptly from one value to another (at lower settings) or whether it makes more continuous transitions from one value to another (at higher settings).

– **Flicker R, G, B Channels:** Three checkboxes let you choose which color channels are affected by this flickering.

Flicker Quality
These controls let you adjust the details of how the flickering animates.

– **Randomness Scale:** This slider lets you introduce irregularity to the Horizontal, Vertical, and Rotational motion of the camera shake. The greater this value, the more irregularity will be introduced.

– **Pause Length:** This slider lets you adjust the frequency of intermittent pauses that break up the random motion added by this filter.

– **Pause Interval:** This slider lets you adjust the duration of intermittent pauses that break up the random motion added by this filter.

– **Pause Randomness:** This lets you add a degree of randomness to the intervals that happen.

– **Random Seed:** This slider lets you alter the value that sets what random values are being produced. Identical values result in identical randomness.

Gamut Limiter
Lets you limit the gamut to a specified standard. Useful in situations where the delivery color space is a large gamut such as Rec. 2020, but the QC specification requires limiting to a smaller gamut such as P3, in order to limit the amount of saturation allowable in the final output. This is a limiting operation, so out of bounds values are hard clipped. This plug-in can be used regardless of whether or not Resolve Color Management is enabled. Because it’s a limiter, it should probably be one of the last operations in any node tree to prevent useful image data from being clipped.

– **Current Gamut:** Choose the timeline gamut currently being used by the image.

– **Current Gamma:** Choose the timeline gamma currently being used by the image.

– **Limit Gamma to:** Choose the gamut you want to restrict the image to here.

These menus present the same options as the Resolve Color Management menus in the Color Management panel. For more information about the options available in these parameters, see Chapter 8, “Data Levels, Color Management, and ACES.”
Gamut Mapping (Studio Version Only)

The Color Space Transform plug-in provides Gamut Mapping controls to accommodate workflows where you need to transform one color space into another that has a dramatically larger or smaller gamut. These controls are identical to those found in the Color Space Transform plug-in’s Gamut Mapping group and are similar to those found in the Color Management panel of the Project Settings.

- **Gamma**: A pop-up menu lets you specify what type of gamma the clip is supposed to have, so set this to whatever matches that image (this may match the timeline color space, but it depends on how you’re working).

- **Tone Mapping Method**: Lets you enable tone mapping, to accommodate workflows where you need to transform one color space into another with a dramatically larger or smaller dynamic range by automating an expansion or contraction of image contrast in such a way as to give a pleasing result with no clipping.

  - **None**: This setting disables Input DRT Tone Mapping. No tone mapping is applied to the Input to Timeline Color Space conversion at all, resulting in a simple 1:1 mapping to the Timeline Color Space.
  
  - **Clip**: Hard clips all out-of-bounds values.
  
  - **Simple**: Uses a simple curve to perform this transformation, compressing or expanding the highlights and/or shadows of the timeline dynamic range to better fit the output dynamic range. Note that the “Simple” option maps between approximately 5500 nits and 100 nits, so if you’re mapping from an HDR source with more than 5500 nits to an SDR destination there may still be some clipping of the highlights above 5500 nits.
  
  - **Luminance Mapping**: Same as DaVinci, but more accurate when the Input Color Space of all your media is in a single standards-based color space, such as Rec. 709 or Rec. 2020.
  
  - **DaVinci**: This option tone maps the transform with a smooth luminance roll-off in the shadows and highlights, and controlled desaturation of image values in the very brightest and darkest parts of the image. This setting is particularly useful for wide-gamut camera media and is a good setting to use when mixing media from different cameras.
  
  - **Saturation Preserving**: This option has a smooth luminance roll-off in the shadows and highlights, but does so without desaturating dark shadows and bright highlights, so this is an effective option for colorists who like to push color harder. However, because over-saturation in the highlights of the image can look unnatural, two parameters are exposed to provide some user-adjustable automated desaturation.

    - **Sat. Rolloff Start**: Lets you set a threshold, in nits (cd/m²), at which saturation will roll off along with highlight luminance. Beginning of the rolloff.
    
    - **Sat. Rolloff Limit**: Lets you set a threshold, in nits (cd/m²), at which the image will be totally desaturated. End of the rolloff.

- **Use Custom Max Input / Output**: Checking these boxes and adjusting the slider below allows you to specify the minimum and maximum luminance of the input image in nits. Using these two sliders together, you can set which value from the Input Gamma is mapped to which value of the Output Gamma.

- **Avg. Input Luminance**: Used to compensate for large differences in the viewer’s state of visual adaptation when viewing a bright image on an HDR display versus seeing that same image on an SDR display. For most “average” images this setting works best set between 0–10. However, when you’re converting very bright images (for example, a snow scene at noon), then using a higher value will yield more image detail within the highlights.
Gamut Mapping Method: Accommodates workflows where you need to transform one color space into another with a dramatically larger or smaller gamut by helping to automate an expansion or contraction of image saturation in such a way as to give a pleasing and naturalistic result with no clipping. Choosing Saturation Mapping lets you remap the saturation values of the image. It enables the Saturation Knee and Saturation Max. controls.

The Saturation Knee slider sets the image level at which saturation mapping begins. Below this level, no remapping is applied. All saturation values from this level on up are remapped according to the Saturation Max. slider. A value of 1.0 is maximum saturation in the currently selected output color space.

The Saturation Max slider sets the new maximum level to which you want to either raise or lower all saturation values that are above the Saturation Knee setting. A value of 1.0 is maximum saturation in the currently selected output color space.

Invert Color

A Color category plug-in that lets you invert any color channel, including the alpha channel. This little plug-in has 101 uses in advanced workflows, especially when you need to invert Alpha or Key channels to do something specific. This is not a “film negative” plug-in; this is a simple inversion.
Chapter 156

Resolve FX Generate

These plug-ins generate imagery that can be used within grades and composites in different ways.

Contents

Color Generator 3023
Color Palette (Studio Version Only) 3023
Grid 3024
General 3024
Line Properties 3024
Color Generator

Generates a single color using a color picker control. Useful in conjunction with a layer node’s ability to mix a color with an image using different composite modes.

- **Color picker**: You can click the color picker and use the resulting color controls to choose a color to be generated.

- **Eyedropper**: You can also click the eyedropper to sample a color from the image in the Viewer; the eyedropper always samples the image from the input of the current node, regardless of how the current image looks.

Color Palette *(Studio Version Only)*

More of an analysis tool than a creative effect, this plug-in offers four Display modes from the pop-up menu at top: Color Palette, Shadow Region, Midtone Region, and Highlight Region.

- **Display Mode**: A pop-up that provides four different options.
  
  - **Color Palette**: By default this displays the eight most dominant colors in the image as rectangular swatches along the bottom, and the eight most dominant colors in each of the three main zones of image tonality (shadow, midtone, highlight) are displayed as smaller rectangular patches just above. This lets you see, at a glance, the color palette of any given shot, and this can be output for intrepid art directors who find it useful.
  
  - **Shadow Region, Midtone Region, or Highlight Region**: Displays a visual preview of which parts of the image fall into which regions (as currently defined by the Shadow and Highlight Threshold sliders). These previews are displayed with the current tonal region appearing saturated and all other parts of the image appearing black.

- **Number of Colors**: Defines the number of isolated colors. This can be set to display anywhere from 8 to 24 patches.

- **Shadow and Highlight Threshold**: The definition of where shadows, midtones, and highlights end and begin is controlled by the Shadow and Highlight Threshold sliders.
Grid

As the name implies, this plug-in generates a grid with two sets of properties.

General

These controls let you adjust the overall density and orientation of the grid.

– **Row Cells and Column Cells:** These sliders let you choose how many cells to divide the grid into, both vertically and horizontally.

– **Pan, Tilt, Zoom, Rotate, Width, Height, ShearX, ShearY, Pitch, and Yaw:** These controls let you transform the grid to serve whatever purpose is necessary.

Line Properties

These controls let you control the properties of the grid lines themselves.

– **Line Color:** This color picker control and accompanying eyedropper let you choose a color with which to draw the grid.

– **Individual Hor. Line Width and Ver. Line Width:** These sliders let you adjust the thickness of all horizontal or all vertical lines.

– **Major Line Spacing:** This slider lets you set every nth line to be thicker, while the Major Line Width control lets you choose how thick to make these major lines.
Chapter 157

Resolve FX Key

DaVinci Resolve includes several Resolve FX dedicated to compositing and keying tasks that are applied directly on the Timeline.

Contents

3D Keyer 3026
General 3026
Selection Range Controls 3026
Matte Finesse 3027
Garbage Matte 3028
Garbage Matte Location 3028
Output 3028
Alpha Matte Shrink and Grow (Studio Version Only) 3029
HSL Keyer 3030
Selection Range Controls 3030
Keyer Options 3031
Matte Finesse 3031
Garbage Matte 3032
Garbage Matte Location 3032
Output 3032
Luma Keyer 3033
Matte Finesse 3034
Garbage Matte 3035
Garbage Matte Location 3035
Output 3035
3D Keyer

Based on the 3D Qualifier in the Color page, the 3D Keyer offers a fast, simple way of pulling a key to isolate a range of color in the image by dragging your mouse pointer over the parts of the image you want to key. Each time you drag over the image you add to or subtract from the cloud of values you're carving out of a three-dimensional representation of all available colors; you don’t see this representation, but this “under the hood” functionality is what gives the 3D Keyer its name.

**TIP:** If you're looking to isolate a range of luma values in the image, you should use the HSL or Luma keyer.

The 3D Keyer is a good one to start with if you’re trying to key a blue screen or green screen background. Its interface of dragging the mouse pointer over the screen color you want to remove, coupled with its high quality and extreme specificity, makes it a fast and accurate tool to use in a variety of circumstances. The 3D Keyer’s greatest strength is the speed with which you can sample areas of the picture to extract from the final key. However, this can also be a weakness if your initial samples aren’t giving you satisfactory results because, unlike the Delta Keyer in the Fusion page, there aren’t many ways to fine-tune the key as it’s being generated. On the other hand, for well-lit subjects you want to key, two or three samples is all you need.

**General**

The top set of controls allows you to set up the 3D Keyer for the initial sampling.

- **Colorspace:** This drop-down menu lets you choose whether you're sampling colors in YUV colorspace or HSL colorspace. YUV is the default, but if you find you're not getting satisfactory results, you can reset the 3D Keyer and switch to HSL to see if that works any better.

- **Softness:** A single parameter lets you adjust the overall softness of the matte created by the 3D Keyer. The default value is 50. Raising this value increases matte softness, lowering it decreases matte softness.

- **Despill:** If you're using the 3D Keyer to pull a blue or green screen key to create transparency, this checkbox lets you turn on an automatic color correction that eliminates blue or green spill from the image while retaining the image’s original color.

- **Show Paths:** A checkbox that lets you turn the visibility of the lines you’re drawing to sample the image on and off. Turning lines off does not affect the key in any way.

**Selection Range Controls**

The Selection Range buttons in the Inspector let you define a key by sampling pixels in the Viewer with the mouse pointer.

![3D Keyer Selection Range controls](image)
– **Sample Eyedropper:** This is the first control you use whenever sampling the image. It defines the initial range of the keyer; you must use this tool before any of the others. In the Edit page, the Timeline Viewer Overlay must be set to Open FX. Clicking once with this tool selects a single pixel value, while clicking and dragging selects a range of image values that add together.

![3D Sample Picker button](image)

– **Add/Subtract Color Range:** These two controls let you add samples to, or subtract them from, the currently selected screen color range that defines the core of the key. As with the eyedropper, you can drag over a range of colors.

![Add and Subtract Color Range buttons](image)

– **Invert:** Inverts the sampled screen color to become opaque, and areas not sampled transparent.

– **Reset:** Resets all the sampled colors while retaining the general control settings.

### Matte Finesse

You may find that sampling the screen color is not enough to overcome some problems. Issues such as chattery edges, holes, or noisy bits can sometimes be easily fixed using the Matte Finesse controls. These controls filter the output of the Keyer and are adjustments that are made to the matte itself, so they may work well in some instances and poorly in others, depending on what you’re trying to do.

– **Denoise:** Denoise provides a distinct way to selectively reduce the noise in a key, getting rid of stray areas of screen color and softly filling “holes” in a matte.

– **Clean Black:** Clean Black is a specialized operation that eliminates noise (seen as white speckling when viewing a high-contrast highlight) in the black area of a key that omits the regions of the image you don’t want to isolate, and shrinks the key by making the dark parts of a key darker the higher you raise this parameter, pushing dark gray areas of the key toward black. The practical result is that raising Clean Black lets you “fill holes” in the background portion of a key and erode translucent edges.

– **Clean White:** Clean White is another specialized operation that eliminates noise (seen as black speckling when viewing a high-contrast highlight) in the white portion of a key that include areas of the image you’re isolating, and expands the key by making light parts of a key lighter the higher you raise this parameter, pushing light gray areas of the key toward white. The practical result is that raising Clean White lets you “fill holes” in the foreground portion of a key and grow translucent edges.

– **Blur Radius:** In small amounts, blurring a key does well to take the edge off problem edges. However, blurring a key can also feather the edges of a key past the border of the subject you’re keying, with the result being a visible “halo” around your subject, depending on the adjustment you’re making. The range is 0 to 2000, with 0 being the default. With such a large maximum blur radius, combined with the capabilities that the In/Out Ratio provides in customizing the direction of spread, you can turn some pretty precarious mattes into surprisingly smooth and useful results.
- **In/Out Ratio:** Controls whether the "Blur Radius" is applied equally to the inside and outside of the edge of the matte (zero), applied only within the matte (negative values), or applied only outside the matte (positive values). Using In/Out Ratio can help eliminate fringing when using the Blur Radius parameter. However, you can also use In/Out Ratio even in situations where no Blur Radius is applied at all. Raising In/Out Ratio will fill in small black holes in the matte, while lowering In/Out Ratio below 0 will eliminate speckling by pushing small white bits of the matte toward black.

- **Black Clip:** Raising Black Clip applies a “lift” adjustment such that translucent areas of the matte (gray areas when viewing a high-contrast highlight) are pushed toward black. The range is 0 to 100, with 0 being the default setting.

- **White Clip:** Lowering White Clip applies a “gain” adjustment such that translucent areas of the matte (gray areas when viewing a high-contrast highlight) are pushed toward white. The range is 0 to 100, with 100 being the default setting.

- **Operation:** This menu lets you choose how you want to modify the alpha channel/key. You can choose Shrink or Grow to dilate or erode the edges of the matte with great accuracy. Or, you can choose Opening or Closing to plug or expand holes to clean up a ragged matte.

- **Shape:** This menu lets you choose how corners and angles in the edges of the key are handled when you grow or shrink it. Circle is the default and results in even expansion around the surface of the key that eventually averages all angles into a circular shape if you use extreme radius settings. Square averages all angles into a more rectangular shape if you use extreme radius settings. Diamond averages all angles into a diamond shape if you use extreme radius settings.

- **Radius:** Adjusts how much to shrink, grow, open, or close the key.

- **Inters:** The Iterations slider alters the effect of the Operator Radius setting to create more extreme adjustments.

### Garbage Matte

These controls let you crop out unwanted things in the frame that are also being keyed, such as lighting fixtures, boom microphones, tracking patches, etc.

- **Matte Shape:** You can choose either a Rectangle or Ellipse with which to crop around the subject you’re keying. Choosing None turns off Garbage Matte. When a garbage matte is enabled, the Open FX Overlay mode of the Viewer shows an on-screen control for adjusting the shape and position of the garbage matte.

- **Edge Softness:** Lets you soften the edges. Defaults to 50; the range is 0 (no softening) to 100 (maximum softening).

- **Invert:** Inverts the garbage matte.

### Garbage Matte Location

These controls provide numeric parameters for adjusting and keyframing garbage mattes.

- **Center X and Y:** Lets you adjust and keyframe the position of a garbage matte.

- **Bounding Width and Height:** Lets you adjust the width and height of the garbage matte.

### Output

The Output controls let you choose how the image is output, composited, and displayed in the Viewer.

- **Output:** This menu offers three options for which channels are output from the effect.
– **Alpha Highlight**: Displays the transparent part of an alpha channel as gray and the solid part of an alpha channel in full color.

– **Alpha Highlight B/W**: Displays the black and white alpha channel, which is often helpful when sampling additional areas to key.

– **Final Composite**: The keyed image is displayed composited over any video track below it.

– **Use Alpha**: A common control in many Resolve FX and 3rd party Open FX plug-ins; this checkbox determines if the alpha channel is used when compositing over another video track. It can be used instead of choosing RGB Only (Blank Alpha) from the Output menu.

### To use the 3D Keyer in the Edit page:

1. Apply the 3D Keyer to a green screen or blue screen clip that’s on a higher track than the background.

2. In the Inspector, enable the Show Paths checkbox to view the sampled areas once you begin.

3. From the Viewer Overlay menu in the lower-left corner of the Timeline Viewer, choose Open FX Overlays.

4. In the Viewer, click and drag to draw a sampling stroke across the screen color you want to remove.

5. The transparency immediately takes effect, showing the keyed subject against whatever clip appears on the video track underneath it in the Timeline as a composite. To see the matte you created for further adjustment, choose Alpha Highlight or Alpha Highlight B/W from the Output drop-down menu.

6. If necessary, you can add or subtract areas from the screen color selection using the add/subtract Color range controls. Alternatively, with the default Sample eyedropper selected, you can hold down Shift to add to the screen color selection or hold down the Option key to remove from the screen color selection.

Ordinarily, it’s a good idea not to select more than two or three times. If you make too many selections in the image, the result can be a key with hard, jagged edges that can sometimes be more difficult to adjust later on.

### Alpha Matte Shrink and Grow

*(Studio Version Only)*

This filter lets you refine the edges of alpha and key mattes in a variety of ways, shrinking and growing the edges, and opening and closing holes that appear within a matte. In the Color page, this filter can be applied to Qualifier or Window keys that have been routed to the RGB input of a corrector node, for adjustment and refinement, before connecting the result to the key input of a subsequent node for use isolating an adjustment.

![Applying the Alpha Matte Shrink and Grow filter to a key matte that's fed to the RGB input of a separate node](image)
- **Operation:** A drop-down menu lets you choose how you want to modify the alpha channel/key. You can choose Shrink or Grow to dilate or erode the edges of the matte with great accuracy. Or, you can choose Opening or Closing to plug or expand holes within the key to clean up a ragged matte.

- **Operator Shape:** A drop-down menu lets you choose how corners and angles in the edges of the key are handled when you grow or shrink it. Circle is the default, and results in even expansion around the surface of the key that eventually averages all angles into a circular shape if you use extreme Radius settings. Square averages all angles into a more rectangular shape if you use extreme Radius settings. Diamond averages all angles into a diamond shape if you use extreme Radius settings.

- **Operator Radius:** A slider adjusts how much to Shrink, Grow, Open, or Close the key.

- **Repeat Operation:** A slider alters the effect of the Operator Radius setting to create more extreme adjustments.

---

**HSL Keyer**

Based on the HSL Qualifier in the Color page, the HSL Keyer is a general-purpose keyer that uses three color components, hue, saturation, and luma, to define a key. In many instances, the HSL Keyer is not as immediately accurate as the 3D Keyer and will include a broader portion of the image for any given sample. On the other hand, if the 3D Keyer is not giving you satisfactory results for a particular shot, the HSL Keyer can sometimes do a better job. The HSL Keyer also gives you the option of disabling color components that you don’t want to contribute to the final key. You can pull a saturation-only key, or a hue-only key, for instances where that may solve the issue at hand.

The most straightforward way to use any keyer is to sample the image in the Viewer. When you sample one or more pixels, the hue, saturation, and luma values are analyzed and set different ranges. There are several eyedropper controls available to sample color and soften the selection.

**Selection Range Controls**

The Selection Range buttons in the Inspector let you define a key by sampling and softening pixels in the Viewer with the mouse pointer.

- **Sample Eyedropper:** This is the first control you use whenever sampling the image. It defines the initial range of the qualification; you must use this tool before any of the others. Clicking once with this tool selects a single pixel value, while clicking and dragging selects a range of image values that add together.

- **Add/Subtract Color Range:** These two controls let you add areas of the image to, or subtract them from, the currently selected inner range of values that define the core of the key. As with the eyedropper, you can click on single pixels or drag over a range of color.

- **Add/Subtract Softness:** These two controls let you redefine the softness that transitions from the inner range of the key, falling off towards the outer edge of the key. Like the other sampling controls, you can click on single pixels or drag over a range of color.

- **Invert:** Inverts the sampled color to become opaque, and areas not sampled become transparent.

- **Reset:** Resets all the sampled colors while retaining the general control settings.
**Keyer Options**

One of the HSL Keyer’s strengths, and one of its most underutilized features, is that you can enable or disable each of the three HSL components using the Hue, Sat, and Lum checkboxes. This lets you ignore specific color components while focusing on others that may be more important. For example, if you’re trying to key the saturated parts of an image, regardless of the hue or brightness, you can turn off Hue and Lum so that only Sat is used to sample it.

![HSL Keyer options](image)

**Matte Finesse**

You may find that sampling the screen color is not enough to overcome some problems. Issues such as chattery edges, holes, or noisy bits can sometimes be easily fixed using the Matte Finesse controls. These controls filter the output of the Keyer and are adjustments that are made to the matte itself, so they may work well in some instances and poorly in others, depending on what you’re trying to do.

- **Denoise**: Denoise provides a distinct way to selectively reduce the noise in a key, getting rid of stray areas of screen color and softly filling "holes" in a matte.

- **Clean Black**: Clean Black is a specialized operation that eliminates noise (seen as white speckling when viewing a high-contrast highlight) in the black area of a key that omits the regions of the image you don’t want to isolate, and shrinks the key by making the dark parts of a key darker the higher you raise this parameter, pushing dark gray areas of the key toward black. The practical result is that raising Clean Black lets you “fill holes” in the background portion of a key and erode translucent edges.

- **Clean White**: Clean White is another specialized operation that eliminates noise (seen as black speckling when viewing a high-contrast highlight) in the white portion of a key that include areas of the image you’re isolating, and expands the key by making light parts of a key lighter the higher you raise this parameter, pushing light gray areas of the key toward white. The practical result is that raising Clean White lets you “fill holes” in the foreground portion of a key and grow translucent edges.

- **Blur Radius**: In small amounts, blurring a key does well to take the edge off problem edges. However, blurring a key can also feather the edges of a key past the border of the subject you’re keying, with the result being a visible “halo” around your subject depending on the adjustment you’re making. The range is 0 to 2000, with 0 being the default. With such a large maximum blur radius, combined with the capabilities that the In/Out Ratio provides in customizing the direction of spread, you can turn some pretty precarious mattes into surprisingly smooth and useful results.

- **In/Out Ratio**: Controls whether the “Blur Radius” is applied equally to the inside and outside of the edge of the matte (zero), applied only within the matte (negative values), or applied only outside the matte (positive values). Using In/Out Ratio can help eliminate fringing when using the Blur Radius parameter. However, you can also use In/Out Ratio even in situations where no Blur Radius is applied at all. Raising In/Out Ratio will fill in small black holes in the matte, while lowering In/Out Ratio below 0 will eliminate speckling by pushing small white bits of the matte toward black.

- **Black Clip**: Raising Black Clip applies a “lift” adjustment such that translucent areas of the matte (gray areas when viewing a high-contrast highlight) are pushed toward black. The range is 0 to 100, with 0 being the default setting.
– **White Clip**: Lowering White Clip applies a “gain” adjustment such that translucent areas of the matte (gray areas when viewing a high-contrast highlight) are pushed toward white. The range is 0 to 100, with 100 being the default setting.

– **Operation**: This menu lets you choose how you want to modify the alpha channel/key. You can choose Shrink or Grow to dilate or erode the edges of the matte with great accuracy. Or, you can choose Opening or Closing to plug or expand holes to clean up a ragged matte.

– **Shape**: This menu lets you choose how corners and angles in the edges of the key are handled when you grow or shrink it. Circle is the default and results in even expansion around the surface of the key that eventually averages all angles into a circular shape if you use extreme radius settings. Square averages all angles into a more rectangular shape if you use extreme radius settings. Diamond averages all angles into a diamond shape if you use extreme radius settings.

– **Radius**: Adjusts how much to shrink, grow, open, or close the key.

– **Inters**: The Iterations slider alters the effect of the Operator Radius setting to create more extreme adjustments.

### Garbage Matte

These controls let you crop out unwanted things in the frame that are also being keyed, such as lighting fixtures, boom microphones, tracking patches, etc.

– **Matte Shape**: You can choose either a Rectangle or Ellipse with which to crop around the subject you’re keying. Choosing None turns off Garbage Matte. When a garbage matte is enabled, the Open FX Overlay mode of the Viewer shows an on-screen control for adjusting the shape and position of the garbage matte.

– **Edge Softness**: Lets you soften the edges. Defaults to 50; the range is 0 (no softening) to 100 (maximum softening).

– **Invert**: Inverts the garbage matte.

### Garbage Matte Location

These controls provide numeric parameters for adjusting and keyframing garbage mattes.

– **Center X and Y**: Lets you adjust and keyframe the position of a garbage matte.

– **Bounding Width and Height**: Lets you adjust the width and height of the garbage matte.

### Output

The Output controls let you choose how the image is output, composited, and displayed in the Viewer.

– **Output**: This menu offers three options for which channels are output from the effect.

  – **Alpha Highlight**: Displays the transparent part of an alpha channel as gray and the solid part of an alpha channel in full color.

  – **Alpha Highlight B/W**: Displays the black and white alpha channel, which is often helpful when sampling additional areas to key.

  – **Final Composite**: The keyed image is displayed composited over any video track below it.

– **Use Alpha**: A common control in many Resolve FX and 3rd party Open FX plug-ins; this checkbox determines if the alpha channel is used when compositing over another video track. It can be used instead of choosing RGB Only (Blank Alpha) from the Output menu.
To use the HSL Keyer in the Edit page:

1. Apply the HSL Keyer to a clip on video track 2 or higher.
2. From the Viewer Overlay menu in the lower-left corner of the Timeline Viewer choose Open FX Overlays.
3. Click and drag across the screen color you want to remove.
4. The transparency immediately takes effect, showing the keyed subject against whatever clip appears on the video track underneath it in the Timeline as a composite. To see the matte you created for further adjustment, choose Alpha Highlight or Alpha Highlight B/W from the Output drop-down menu.
5. To add or subtract from the matte, click the plus or minus Color Range control, and click or drag across the portion of the keyed image.
6. To add softness to the outer range of the key you’re creating, click the plus Softness control and then click or drag across the portion of the image you’d like to include as a soft edge.

Luma Keyer

Based on the Luma Qualifier in the Color page, the Luma Keyer pulls a key from the luma channel. It’s identical to the HSL Keyer with H and S turned off. Although not often used by itself, the Luma Keyer can produce very dramatic effects when used in conjunction with Composite modes.

Selection Range Controls

The Selection Range buttons in the Inspector let you define a key by sampling pixels in the Viewer with the mouse pointer.

- **Sample Eyedropper**: The first control you use whenever sampling the image. It defines the initial range of the keyer; you must use this tool before any of the others. In the Edit page, the Timeline Viewer Overlay must be set to Open FX. Clicking once with this tool selects a single pixel value, while clicking and dragging selects a range of image values that add together.

- **Add/Subtract Luma Range**: These two controls let you add areas of the image to, or subtract them from, the currently selected luma range that defines the core of the key. As with the eyedropper, you can click on single pixels, or drag over a range of color.

- **Add/Subtract Softness**: These two controls let you redefine the softness that transitions from the inner range of the key, falling off towards the outer edge of the key. Like the other keying controls, you can click on single pixels, or drag over a range of color.

- **Invert**: Inverts the sampled luma range to become opaque, and areas not sampled become transparent.

- **Reset**: Resets the sampled luma range while retaining the Output control settings.
Matte Finesse

You may find that sampling the screen color is not enough to overcome some problems. Issues such as chattery edges, holes, or noisy bits can sometimes be easily fixed using the Matte Finesse controls. These controls filter the output of the Keyer and are adjustments that are made to the matte itself, so they may work well in some instances and poorly in others, depending on what you’re trying to do.

- **Denoise**: Denoise provides a distinct way to selectively reduce the noise in a key, getting rid of stray areas of screen color and softly filling “holes” in a matte.

- **Clean Black**: Clean Black is a specialized operation that eliminates noise (seen as white speckling when viewing a high-contrast highlight) in the black area of a key that omits the regions of the image you don’t want to isolate, and shrinks the key by making the dark parts of a key darker the higher you raise this parameter, pushing dark gray areas of the key toward black. The practical result is that raising Clean Black lets you “fill holes” in the background portion of a key and erode translucent edges.

- **Clean White**: Clean White is another specialized operation that eliminates noise (seen as black speckling when viewing a high-contrast highlight) in the white portion of a key that include areas of the image you’re isolating, and expands the key by making light parts of a key lighter the higher you raise this parameter, pushing light gray areas of the key toward white. The practical result is that raising Clean White lets you “fill holes” in the foreground portion of a key and grow translucent edges.

- **Blur Radius**: In small amounts, blurring a key does well to take the edge off problem edges. However, blurring a key can also feather the edges of a key past the border of the subject you’re keying, with the result being a visible “halo” around your subject depending on the adjustment you’re making. The range is 0 to 2000, with 0 being the default. With such a large maximum blur radius, combined with the capabilities that the In/Out Ratio provides in customizing the direction of spread, you can turn some pretty precarious mattes into surprisingly smooth and useful results.

- **In/Out Ratio**: Controls whether the “Blur Radius” is applied equally to the inside and outside of the edge of the matte (zero), applied only within the matte (negative values), or applied only outside the matte (positive values). Using In/Out Ratio can help eliminate fringing when using the Blur Radius parameter. However, you can also use In/Out Ratio even in situations where no Blur Radius is applied at all. Raising In/Out Ratio will fill in small black holes in the matte, while lowering In/Out Ratio below 0 will eliminate speckling by pushing small white bits of the matte toward black.

- **Black Clip**: Raising Black Clip applies a “lift” adjustment such that translucent areas of the matte (gray areas when viewing a high-contrast highlight) are pushed toward black. The range is 0 to 100, with 0 being the default setting.

- **White Clip**: Lowering White Clip applies a “gain” adjustment such that translucent areas of the matte (gray areas when viewing a high-contrast highlight) are pushed toward white. The range is 0 to 100, with 100 being the default setting.

- **Operation**: This menu lets you choose how you want to modify the alpha channel/key. You can choose Shrink or Grow to dilate or erode the edges of the matte with great accuracy. Or, you can choose Opening or Closing to plug or expand holes to clean up a ragged matte.

- **Shape**: This menu lets you choose how corners and angles in the edges of the key are handled when you grow or shrink it. Circle is the default and results in even expansion around the surface of the key that eventually averages all angles into a circular shape if you use extreme radius settings. Square averages all angles into a more rectangular shape if you use extreme radius settings. Diamond averages all angles into a diamond shape if you use extreme radius settings.

- **Radius**: Adjusts how much to shrink, grow, open, or close the key.

- **Inters**: The Iterations slider alters the effect of the Operator Radius setting to create more extreme adjustments.
Garbage Matte

These controls let you crop out unwanted things in the frame that are also being keyed, such as lighting fixtures, boom microphones, tracking patches, etc.

- **Matte Shape**: You can choose either a Rectangle or Ellipse with which to crop around the subject you're keying. Choosing None turns off Garbage Matte. When a garbage matte is enabled, the Open FX Overlay mode of the Viewer shows an on-screen control for adjusting the shape and position of the garbage matte.
- **Edge Softness**: Lets you soften the edges. Defaults to 50, the range is 0 (no softening) to 100 (maximum softening).
- **Invert**: Inverts the garbage matte.

Garbage Matte Location

These controls provide numeric parameters for adjusting and keyframing garbage mattes.

- **Center X and Y**: Lets you adjust and keyframe the position of a garbage matte.
- **Bounding Width and Height**: Lets you adjust the width and height of the garbage matte.

Output

The Output controls let you choose how the image is output, composited, and displayed in the Viewer.

- **Output**: This menu offers three options for which channels are output from the effect.
  - **Alpha Highlight**: Displays the transparent part of an alpha channel as gray and the solid part of an alpha channel in full color.
  - **Alpha Highlight B/W**: Displays the black and white alpha channel, which is often helpful when sampling additional areas to key.
  - **Final Composite**: The keyed image is displayed composited over any video track below it.
  - **Use Alpha**: A common control in many Resolve FX and 3rd party Open FX plug-ins; this checkbox determines if the alpha channel is used when compositing over another video track. It can be used instead of choosing RGB Only (Blank Alpha) from the Output menu.

To use the Luma Keyer in the Edit page to key a subject:

1. Apply the Luma Keyer to a clip on video track 2 or higher.
2. From the Viewer Overlay menu in the lower-left corner of the Timeline Viewer choose Open FX Overlays.
3. Either click a pixel in a bright or dark part of the image you want to key out, or click and drag across a range of pixels within that subject.
4. The transparency immediately takes effect, showing the keyed subject against whatever clip appears on the video track underneath it in the Timeline as a composite. To see the matte you created for further adjustment, choose Alpha Highlight or Alpha Highlight B/W from the Output drop-down menu.
5. To add or subtract from the matte, click the plus or minus Luma Range buttons, and then click or drag across the portion of the keyed image.
6. To add softness to the outer range of the key you're creating, click the plus Softness button and then click or drag across the portion of the image you'd like to include as a soft edge.
The plug-ins in this category all replicate different optical and lighting effects. While most have been designed to quickly give you realistic results, all can be pushed harder to provide many artistic effects.

Contents

**Aperture Diffraction** (Studio Version Only) 3037
Output 3037
Isolation Controls 3037
Aperture Controls 3038
Compositing Controls 3038

**Glow** 3038

**Lens Flare** (Studio Version Only) 3039
Lens Flare Preset 3039
Select Output 3039
Light Source Masking 3039
Position 3040
Global Corrections 3040
Aperture 3040
Elements 3040

**Lens Reflections** (Studio Version Only) 3042
Output 3042
Isolation Controls 3042
Global Controls 3043
Presets 3043
Reflecting Elements 3043

**Light Rays** 3044
Main Controls 3044
Position 3044
Appearance 3044
Aperture Diffraction **(Studio Version Only)**

Found in the ResolveFX Light category, Aperture Diffraction models the starburst effect usually seen when shooting bright lights with small apertures, the physical cause of which is light-diffraction on the aperture blades of a lens. This plug-in simulates this, with the result being automatically applied to scene highlights that you can isolate and refine, with customizable virtual apertures.

Small regions of brightness exhibit a star pattern glow, as seen in the following image.

![Original image, Applying Aperture Diffraction](image1)

Large regions of brightness exhibit a more even glow with shaping and texture that look like a natural optical effect. It can be used to create a different type of glow effect with a more realistic look in some situations than the Glow plug-in, though it’s more processor intensive. In other situations, this plug-in opens up many different stylistic possibilities for glowing effects.

![Original image, Applying Aperture Diffraction](image2)

**Output**

These controls let you choose what image is output by this plug-in.

- **Select Output**: Lets you preview the image with different stages of the Aperture Diffraction effect applied, viewing the Isolated Source (to help when adjusting the Isolation controls), Preview Aperture (to help when adjusting the Aperture controls), Preview Diffraction Pattern (showing you the resulting diffraction pattern based on the aperture control settings), Diffraction Patterns Alone (showing you the glow effect that will be applied to the image by itself), and the Final Composite.

- **Quality**: Lets you choose a quality setting to trade off between quality and speed. Choices are Full, Half (Faster), Quarter (Fast).

**Isolation Controls**

The Isolation controls let you choose which highlights in the scene generate visible glow and patterns. The effect of these controls can be directly monitored by setting Select Output to Isolated Source.
– **Color Mode:** A pop-up menu that lets you either choose to keep the colors of the different highlight regions that generate glow, or treat them all as grayscale brightness only (color controls later can change the effect). Grayscale is faster to process, but Color can result in some brilliant effects.

– **Brightness:** Sets the threshold at which highlights are isolated.

– **Gamma:** Lets you shape the isolated highlights.

– **Smooth:** Lets you blur details in the highlights that you don’t want to be pronounced.

– **Color Filter:** Lets you choose a particular color of highlight to isolate (an eyedropper lets you select a value from the Viewer).

– **Operation:** Lets you adjust the resulting Isolation matte (options include Shrink, Grow, Opening, Closing) with a slider to define how much.

**Aperture Controls**

The Aperture controls let you define the shape and texture of the resulting glow this plug-in creates.

– **Iris Shape:** Lets you choose a shape that determines how many arms the star pattern will have. Options are Triangle, Square, Pentagon, Hexagon, Heptagon, and Octagon.

– **Aperture Size:** Lets you alter the resulting diffraction pattern alternating between more of a star shape at higher values and a stippled wave pattern at lower values.

– **Result Gamma:** Lets you adjust how pronounced will be the glow that appears between the arms of the star patterns that appear.

– **Result Scale:** Lets you alternate between pronounced star patterns at high values and more diffuse glows at low values.

– **Blade Curvature and Rotation:** Let you alter the softness and orientation of the arms of each star.

– **Chroma Shift:** Lets you introduce some RGB “bleed” into the glow.

**Compositing Controls**

These controls let you adjust how to composite the glow effect against the original image.

– **Normalize Brightness:** This checkbox scales the brightness of the glow to a naturalistic range for the image. Also, when Normalize Brightness is enabled, the Aperture Diffraction effect will keep to a consistent overall brightness as the scene changes.

– **Brightness:** Lets you adjust the intensity of the glow effect.

– **Colorize:** Lets you tint the glow effect using a Color control that appears when Colorize is raised above 0.

**Glow**

A sophisticated, soft glow effect that’s highly customizable with only a few key parameters.

– **Select Output:** Lets you preview the image with different stages of the glow effect applied, viewing the Shiny Regions, the isolated Glow Alone, or the Glowing Image.

– **Shine Threshold:** Defines the luminance level at which glow is triggered to appear on the image.

– **Spread:** Defines how far out shine extends from areas of the picture that trigger it.

– **H/V Ratio:** Lets you adjust the proportion of horizontal to vertical spread, allowing you to create “streaky” shine that extends farther in a particular dimension.
– **Relative Spread Red/Green/Blue**: Lets you adjust the spread within each color channel by a different amount, simulating a kind of chromatic aberration in the glow.

– **Brightness**: Adjusts the intensity of the glow effect.

– **Colorize**: A color picker and eyedropper let you choose a color with which to tint the glow.

– **Glow framing**: Lets you choose what happens when shine hits the edge of the frame, whether it’s amplified by “Reflect in Camera” or whether it’s moderated by a “Vignette” effect.

– **Composite Type**: Lets you choose a composite mode to use to blend the glow effect with the image. Defaults to Screen, which is good for gentle glows. Add lets you create hotter, more intense glows, while other composite modes let you create other varied effects.

– **Opacity**: Lets you adjust the transparency of the glow effect and is a fast way of “easing off” of a glow that you otherwise like, but that’s too intense for the shot at hand.

### Lens Flare (Studio Version Only)

Simulates different kinds of lens flares resulting from the interplay of light through an aperture of selectable shape bouncing within layered optical elements in a lens. Lens Flares are completely computer-generated, so they’re always created at your project resolution, whether it’s 1080 or 8K. Four groups of controls give you a lot of ways to customize the presets to create your own effect:

#### Lens Flare Preset

You can choose a type of flare from the Lens Flare Preset pop-up. If you manipulate the controls to create your own effect, this pop-up switches to Custom.

#### Select Output

The Select Output pop-up lets you switch among the following viewing options:

– **Final Image**: (Default) Shows the lens flare composited against the current clip.

– **Flare Elements Alone**: Shows the isolated flare, making it easier to adjust.

– **Source Mask and Magnified Source Mask**: Let you see the mask created by the Light Source Masking controls below, which is used to limit the lens flare that’s created.

#### Light Source Masking

Three additional controls at the top let you create a quick and dirty luma key to create a mask that you can use for occluding the lens flare effect behind foreground elements in the scene. For example, if you’re using lens flare to simulate the sun in the sky, these controls let you mask trees in the foreground so that the lens flare appears to be behind the trees, as the sun would be.

– **Enable Light Source Masking**: This checkbox enables the Mask Threshold and Virtual Light Source Size sliders. You can then choose either Source Mask or Magnified Source Mask to see the mask that’s created by raising the Mask Threshold slider.

– **Mask Threshold**: Raising this slider pulls a fast Luma Key that masks off darker foreground elements (such as trees against the horizon) and limits the flare to areas of the picture where the light source of the flaring can “shine through” (In this example, shining between the trees on the horizon.).

– **Virtual Light Source Size**: This slider determines how quickly the center of a flare will disappear behind the luma-keyed mask you’ve created; higher values (simulating bigger light sources) cause a flare to disappear more slowly when passing “behind” a feature of the image that’s being keyed via the Mask Threshold slider.
Position

Position parameters let you adjust the X and Y Position of the simulated light source that’s causing the flare. There are three ways you can adjust the flare position.

– You can adjust the X and Y Position sliders.
– You can turn on the OpenFX Overlay in the Viewer and drag the on-screen control.
– You can motion track elements within the scene using the FX mode of the Tracker palette.

Global Corrections

The Global Corrections group have parameters that let you quickly adjust the overall quality of the flare effect.

– Global Scaling: Lets you make every element of the flare effect larger or smaller at once.
– Anamorphism: Lets you stretch all flare elements horizontally to simulate an anamorphic lens’ stretching effect.
– Lens Center X and Y position: Lets you offset the center of the simulated lens that’s causing the flaring, about which the various elements of the flare pivot.
– Global Defocus: Lets you blur the overall flaring effect being created to soften the effect.
– Global Brightness: Lets you raise and lower the overall level of flaring being produced.
– Global Saturation: Lets you adjust the overall color intensity of the flaring.
– Colorise Result: Lets you choose how much to tint the flare, if at all. At a value of 0 (the default), no colorization is applied at all.
– Colorization Color: Lets you choose a color to use to colorize the flare via the Colorize Result slider above. You can use either a color control or eyedropper to sample color from the source RGB image of the current node.

Aperture

The Aperture parameters let you define the aperture of the simulated camera apparatus through which the flare is being generated. The shape defined by these parameters affects the look of the “starburst element” of each flare, as well as the look of any aperture-shaped “ghost elements” you’re turning on.

– Aperture Blades: Defines how many blades make up the aperture. You can choose from 3 to 16 (defaults to 6).
– Angle: Sets the angle of the resulting Aperture shape (defaults to 0.183).

Elements

The Elements pop-up is a deceptively simple set of controls that let you expose the customization controls of each of the layers and elements that combine to create the simulated lens flare. Up to ten levels of elements can contribute to a lens flare effect. Each element and ghost shape has a different set of parameters unique to that type of element. Available elements in this pop-up menu include:

– Full-Screen Glare: A simulated overall flaring that covers the entire frame at its most intense. This glare increases as the flare nears the center of the screen and decreases as the flare moves toward the edges of the frame. Recommended for extremely big flaring effects. Parameters include:
  – Glare Brightness: A slider; set this to 0 to eliminate glare.
  – Glare Color: A color picker and eyedropper combination that lets you tint the glare.
– Flare Spot: Simulates the central light source that’s triggering the flare. Parameters include Flare Size (set this to 0 to eliminate the flare spot), Flare Irregularity (which lets you create a more organic-looking, off-balance flare), Flare Softness, and Flare Color.
– **Starburst**: Rays of light stretching out from the center of the flare. Parameters include Starburst Size (set this to 0 to eliminate the starburst), Starburst Softness, Starburst Split Angle (which splits each streak of the starburst into a wider feathered pattern), Starburst Split Balance (which lets you adjust the brightness between each half of split streaks), and Starburst Color.

– **Ghost elements**: Seven available layers of Ghost Elements can be enabled and set to different optional shapes for each lens element you want to simulate. Each of the Ghost element layers can use one of five types of shapes, including:

  – **None**: Turns that particular ghost element off.
  – **Aperture Shape**: A polygonal shape defined by the number of blades in the aperture you’ve selected.
  – **Anamorphic Streak**: A wide horizontal artifact typical of anamorphic lenses.
  – **Disc Shape**: A round ring artifact.
  – **Bubble Shape**: An oval with haze within.
  – **Corona Rays**: A ring of streaks stretching outward.

Ghost elements share many parameters in common, although specific elements have unique parameters. These parameters are as follows:

  – **Color**: A color picker and eyedropper combination that lets you colorize that specific element.
  – **Position**: A slider lets you set that element’s position along the optical path that’s defined by the angle from the (Flare) Position X and Y to the Lens Center X and Y parameters. A value of 0 centers that element on the Lens Position, while larger values push that element farther and farther away from the Lens Position.
  – **Size**: Sets the size of that flaring element, or in the case of the Anamorphic Streak, the width.
  – **Height**: (Anamorphic Streak only) Sets the vertical thickness of the streak.
  – **Center Brightness**: (Aperture, Disk, and Anamorphic Streak only) Defines the brightness in the middle of that element, filling it to appear as a solid element. Set this closer to 0 if you want the element to appear hollow.
  – **Edge Brightness**: (All but Anamorphic Streak) Defines the brightness of the edge of that element. Raising this value while lowering the Center Brightness lets you create outlined element effects.
  – **Softness**: Lets you blur that element.
  – **Bristle Density**: (Corona Only) Lets you alter the number and arrangement of the optical bristles that appear. At lower values, fewer bristles appear, at higher values, more bristles appear. As you change the value of this parameter, the placement of bristles shifts, allowing you to change distribution as well as density with a single control.
  – **Bristle Scale**: (Corona only) Lets you alter the thickness of the bristles that appear. Smaller values result in thicker bristles, higher values result in smaller bristles more tightly packed together.
  – **Ringing**: (All types but Bubble) Simulates a pattern of diffraction artifacts. Higher values increase the number of rings or streaks comprising the element.
  – **Chromatic shift**: Simulates chromatic aberration effects.
  – **Eclipse Position**: Simulates where the outer (away from the center) or inner (toward the center) side of a Ghost Element doesn’t exist because the light is occluded by the edge of a lens element or some part of the tube housing. Practically, this defines which side of the Ghost Element is affected by the other Eclipse parameters of size, softness, and chromatic shift. Adjusting this results in semi-circular ghost shapes of different kinds. At 0, there is no eclipse. At positive values, the eclipse starts from within the frame and pushes out; at negative values, the eclipse starts from the outside of the frame and pushes in.
- **Eclipse Size**: Defines the size of the eclipse region for that flare element. At higher values, more and more of the flare element is eclipsed.

- **Eclipse Softness**: Defines the softness at the transition from the eclipsed and non-eclipsed regions.

- **Eclipse Chromatic shift**: Lets you create a chromatic aberration effect at the boundary of the eclipsed region. At 0, there is no chromatic shift. At increasingly positive values, there’s a shift toward blue. Toward negative values, there’s a shift toward red.

- **Repeat**: Lets you use this element to spawn many duplicates defined by the following two parameters.

- **Repeat Position Seed and Repeat Size Seed**: At different values, these parameters let you pseudo-randomly redistribute the placement of repeated elements.

---

**Lens Reflections** *(Studio Version Only)*

Found in the ResolveFX Light category, Lens Reflections simulates intense highlights reflecting off the various optical elements within a lens to create flaring and scattering effects based on the shape and motion of highlights you isolate in the scene. It’s an effective simulation that works best when there are light sources or specular reflections in the scene such as the sun, car headlights, light fixtures, fire and flame, or other lighting elements that are plausibly bright enough to cause such flaring.

Also, this plug-in really shines when these light sources move, as each layer of simulated reflections moves according to that element’s position within the virtual lens being simulated, creating organic motion that you don’t have to keyframe. Without intense highlights, the results of this filter will be somewhat abstract.

![Original image](left) ![Applying Lens Reflections](right)

**Output**

The Output controls let you preview the image with different stages of the Lens Reflections effect applied.

- **Select Output**: Lets you choose to view the Isolated Source (to help when adjusting the Isolation controls), Reflections Alone (showing you the flaring effect that will be applied to the image by itself), or the Final Composite (the complete effect).

- **Quality**: This pop-up lets you choose how to render the effect. Options are Full, Half (Faster), and Quarter (Fast). The tradeoff is between quality and speed.

**Isolation Controls**

The Isolation controls let you choose which highlights in the scene will generate lens reflections. The effect of these controls can be directly monitored by setting Select Output to Isolated Source. It’s highly recommended to customize the Isolation controls for the image at hand when using this plug-in,
as even more so than other plug-ins, the particular highlights used will have a huge impact on the resulting effect.

- **Color Mode:** A pop-up menu that lets you either choose to keep the colors of the different highlight regions that generate lens reflections, or treat them all as grayscale brightness only (color controls later can change the effect). Grayscale is faster to process, but Color can result in some brilliant effects.
- **Brightness:** Sets the threshold at which highlights are isolated.
- **Gamma:** Lets you shape the isolated highlights.
- **Smooth:** Lets you blur details in the highlights that you don’t want to be pronounced.
- **Color Filter:** Lets you choose a particular color of highlight to isolate (an eyedropper lets you select a value from the Viewer).
- **Operation:** A pop-up lets you adjust the resulting Isolation matte (options include Shrink, Grow, Opening, Closing), and a slider lets you define how much.

**Global Controls**

The Global controls let you quickly and easily adjust the overall quality of the Lens Reflections effect using a centralized group of parameters.

- **Global Brightness:** Lets you raise and lower the level of all reflections. Lowering brightness is a good way to make a large lens reflection effect more subtle, although images with small lens reflection effects may benefit from being a little brighter.
- **Global Blur:** Lets you defocus all reflections. This is another good way of making lens reflection effects of all kinds more subtle.
- **Anamorphism:** Lets you deform the reflection elements to simulate an anamorphic lens’ stretching effect.
- **Global Colorize:** Lets you adjust the color intensity of the reflections, either intensifying the color of all reflections or desaturating it.

**Presets**

A Presets pop-up provides a number of different settings to get you started. Selecting a preset populates the Reflecting Elements parameters below, at which point you can customize the effect to work best with the image at hand. It’s highly recommended to customize these effects to suit the type of highlights in your image, in order to get the best results.

**Reflecting Elements**

There are four groups of Reflecting elements, each with identical controls. This lets you create interactions combining up to four sets of reflections. The controls found within each group are as follows.

- **Brightness:** Lets you adjust the intensity of that reflection.
- **Position in Optical Path:** Lets you shift the reflection according to an element’s position in the lens. Practically, this means that positive values will enlarge an inverted reflection based on the highlights, while reducing values toward 0 will shrink the reflection, and pushing this into negative values will invert the reflection and pull it into the opposite direction as it begins to enlarge again. A value of –1 positions the reflection right over the highlight that creates it.
- **Defocus type:** Lets you choose what kind of blur to use, choices include Box blur, Triangular blur, Lens blur (the most processor intensive), and Gaussian blur (the default).
- **Defocus:** Lets you choose how much to blur that element.
- **Stretch:** Lets you give the flare an anamorphic widescreen look.
– **Stretch Falloff:** Lets you taper the edges for a less uniform stretching effect.

– **Lens Coating:** A pop-up lets you choose common colors such as purple, green, and yellow that correspond to different anti-reflective lens coatings, as well as a selection of other vibrant colors. Defaults to none. When you choose any other option, a color control and eyedropper let you manually choose a color or pick one from the image. A Colorize slider lets you vary how much to tint the reflection by the selected color, although setting Colorize to 0 lets the flare take its color from the source highlights of the image, which can sometimes give you the most interesting look.

### Light Rays

A “rays of light” effect that simulates volumetric lighting emerging from light sources defined by a threshold you define. The effect mimics what are sometimes called “god rays” in the sky, or other highly directional glow effects.

### Main Controls

The Main controls include:

– **Select Output:** Lets you preview the image with different stages of the Lightray effect applied, viewing the Final Image, Lightrays Alone, and Source Regions.

– **Source of Rays:** Lets you choose the emitter of the rays, using Bright Regions or Edges.

– **Source Threshold:** A slider that lets you choose the limit at which light areas of the image emit rays.

### Position

Position parameters let you define the direction rays take.

– **Ray Directions:** A pop-up menu that lets you choose either “From A Location,” which exposes controls to let you choose an X or Y position to define a point of origin that defines the angle of the light beams, or “At an Angle,” which exposes controls to let you choose an overall orientation for the rays.

### Appearance

Appearance parameters let you customize the ray effect.

– **Ray Dropoff:** A pop-up with four options.
  – **Default (soft):** Produces soft, indistinct rays of light that appear to fade away as they stream out.
  – **Keep Shape of Source:** The edge of the light rays are defined by the shape that emitted them.
  – **CCD Bloom Harsh:** Severely raises the brightness of the part of the image that’s emitting rays as Length is raised, resulting in harsh glow or bloom in the image.
  – **CCD Bloom Soft:** Gently raises the brightness of the part of the image that’s emitting rays as Length is raised, resulting in a very gentle lightning of the image.

– **Length:** Lets you make the rays longer or shorter.

– **Soften:** Lets you blur the rays being emitted.

– **Brightness:** Lets you adjust how bright the rays are.

– **Color:** A color picker and eyedropper let you define a color with which to tint the rays.
Chapter 159

Resolve FX Refine

These plug-ins let you make different kinds of targeted improvements.

Contents

**Beauty** *(Studio Version Only)*
- Operating Mode 3046
- Auto Controls 3046
- Advanced Controls 3047

**Face Refinement** *(Studio Version Only)*
- Main Controls 3048
- Skin Mask 3049
- Texture 3049
- Color Grading 3051
- Eye Retouching 3051
- Lip Retouching 3051
- Blush Retouching 3052
- About Forehead, Cheek, and Chin Retouching 3052
- Forehead Retouching 3053
- Cheek Retouching 3053
- Chin Retouching 3053
**Beauty (Studio Version Only)**

Beauty is a plug-in that lets you control texture. In Advanced mode, you can selectively smooth image detail that falls above a particular threshold (using the Smoothing Threshold slider), while preserving detail falling below a particular threshold (using the Texture Threshold slider). In this way, you can smooth larger textures you don’t want, while either preserving or exaggerating smaller textures that you do want.

In the case of faces and skin, this plug-in provides another method of smoothing larger, unwanted blemishes, while preserving desirable edge detail and underlying structures such as pores, so you can improve the complexion of subjects on shoots where hair and makeup was not available, without over-softening realistic skin details and creating an overly fake plastic look.

![Left image](image1) ![Right image](image2)

(Left) The original image. (Right) A face with Beauty applied to soften the complexion while retaining fine facial detail

Please note that this plug-in is not only for skin detail, and it’s not only for softening. Once you isolate the fine detail you want to preserve in a subject, you also have the option of exaggerating it to create highly textured results. This plug-in is effective for any subject with textures that need refinement.

**TIP:** This plug-in is best used within a qualification that isolates the particular feature you’re trying to smooth. The default settings apply a moderate amount of smoothing and fine detail recovery that’s appropriate for faces in closeup but will not be universally appropriate for all situations, so some fine-tuning will always be necessary. For naturalistic results, this plug-in produces the best results when used in moderation.

**Operating Mode**

The Beauty plug-in has two operational modes, including an Automatic mode with simpler operation when your objective is to create a maximally smooth or textured result while still preserving important details, and an Advanced mode that provides additional controls that let you preserve fine detail that you want, while smoothing coarse details that you don’t want.

**Auto Controls**

Automatic mode reveals easy-to-use controls for smoothing or coarsening detail.

- **Amount:** Lets you choose how much smoothing or coarsening to apply.

- **Scale:** Lets you reduce or increase the amount of smoothing or coarsening that’s accomplished with the range of the Amount slider.
Advanced Controls

Advanced controls reveal the full power of the Beauty plug-in, with preview modes to examine different aspects of this plug-in’s behavior, while specifically adjusting the level of smoothing or coarsening you want, the amount of texture to preserve, and which additional features of the subject you want to recover from this operation to fine tune the result.

- **Show Split View:** Turns on a split-screen view that displays a grid of four images (in clockwise order from upper left): the smoothed or coarsened image, the Texture Recovery mask, the Feature Recovery mask, and the final result. The Split View works best with the Full Screen Viewer enabled (press Shift-F) while the Inspector is shown at right, so each quadrant is large while you make your adjustments.

### Smoothing

These parameters let you adjust how much smoothing to apply to the image.

- **Smoothing Threshold:** Raising this value increasingly smooths textures above the Texture Threshold (below). Using this control and leaving Diffuse Lighting at 0 preserves the contrast of the lighting on the feature you’re smoothing.

- **Diffuse Lighting:** Another method of softening texture, but in such a way that the lighting of the subject also appears to become more and more diffuse (Similar to setting Midtone Detail to negative values).

- **Preview Smoothed:** Lets you view the image with only smoothing applied by the Smoothing Threshold and Diffuse Lighting sliders, with no texture recovery.

### Texture Recovery

These parameters let you adjust how much texture to put back into the smoothed result.

- **Texture Threshold:** Lets you set the threshold at which detail is reintroduced to the image. Texture Threshold must always be equal to or lower than Smoothing Threshold, so lowering Smoothing Threshold may also result in lowering Texture Threshold.

- **Add Texture:** Lets you exaggerate recovered texture (at values higher than 1), or minimize recovered texture (at values less than one).

- **Preview Texture:** Lets you view the isolated texture mask that’s being recovered by the Texture Gain and Texture Threshold sliders, so you can fine tune what you want to preserve.

### Feature Recovery

These parameters let you recover edge detail.

- **Recovery Amount:** Lets you set the threshold at which detail is reintroduced to the image. Texture Threshold must always be equal to or lower than Smoothing Threshold, so lowering Smoothing Threshold may also result in lowering Texture Threshold.

- **Preview Recovery Area:** Lets you view the mask that’s being generated by the Recovery Amount slider, so you can fine tune what you want to preserve. Preserved detail is white, discarded detail is black.
Face Refinement (Studio Version Only)

Face Refinement is an incredibly sophisticated yet easy-to-use filter that lets you quickly make very targeted adjustments to people’s complexions. When you apply this filter, imaging techniques are used to automatically detect a face, which is automatically tracked so long as it’s somewhat turned toward the camera.

If multiple faces are present in the frame at the position of the playhead, then clicking the Analyze button once results in boxes being drawn over each detectable face. Click any of these boxes to choose which face you want to refine, and that box will be highlighted to indicate which face you’ll be refining.

If only one face is present, clicking the Analyze button automatically analyzes that face; no boxes appear and this step is not necessary.

After you’ve selected which face to track (if necessary), you need only click the Analyze button at the top of the Face Refinement controls to “auto-magically” track the face through the trackable range of motion that this plug-in is capable of, and an outline of the face’s major features appears to let you follow its progress.

Once the face has been tracked, you’re ready to work. This plug-in divides the tracked face into different zones for common operations colorists often perform to quickly eliminate blemishes, adjust the hue and saturation of complexions in regionally appropriate ways, modify lighting, sharpen desirable detail, and refine makeup. Because all adjustments are fit to the proportions of the face that’s been detected and tracked, all you need to do is make the adjustments you need and DaVinci Resolve takes care of the rest.
Main Controls

The top two controls let you initiate the Face Refinement process.

- **Analyze:** This button initiates the process of using the facial detection of the Face Refinement plug-in to detect the face you want to make adjustments for, and track its motion throughout the range of the clip. You only need to do this once, and the data will be stored.

- **Show overlay:** To impress your clients and see how well Face Detection is tracking the face you’re working on, you can turn on this checkbox, which turns on the wireframe tracking that shows you which facial details are being detected.

Skin Mask

These controls let you adjust the skin mask this plug-in automatically generates in order to limit the effect to only the face of the person you’re targeting.

- **Use mask:** This checkbox enables DaVinci Resolve to sample the dominant skin tone values within the face to create a complexion-focused key to isolate the skin tones of the image. However, since it’s still possible to have blonde hair, wood panelling, or other skin-colored features in the frame that inadvertently get included in this key.

- **Use face mask:** Turning on this checkbox places a circular garbage mask that follows the face to eliminate these accidental inclusions.

- **Face mask size and Face mask softness:** These sliders let you adjust the face mask to better fit the face you’re working on, if necessary.

- **Refine mask:** This slider lets you adjust the face mask to smooth or eliminate gaps in the key.

- **Show mask:** This checkbox makes the face mask being generated visible, which can be helpful to see while you’re tuning it.

- **Show overlay:** To impress your clients and see how well Face Detection is tracking the face you’re working on, you can turn on this checkbox, which turns on the wireframe tracking that shows you which facial details are being detected.

Texture

The Texture controls have three Operating Modes that let you choose the method you want to use to control skin texture. Beauty Automatic and Beauty Advanced provide the texture controls available in the Beauty plug-in, while Smoothing provides the previously available texture adjustment controls.
Beauty Automatic Controls

Automatic mode reveals easy-to-use controls for smoothing or coarsening detail.

- **Amount**: Lets you choose how much smoothing or coarsening to apply.
- **Scale**: Lets you reduce or increase the amount of smoothing or coarsening that’s accomplished with the range of the Amount slider.

Smoothing Controls

- **Smoothing**: This slider removes detail from the areas isolated by the Skin Mask controls, smoothing the complexion. Its operation depends on the settings of the Detail Size and Detail sliders below. You may find you can increase Smoothing more dramatically as you increase Detail using the Detail Size and Detail sliders described below.

- **Detail Size and Detail**: Once you’ve used the Smoothing slider, you can then use these sliders to selectively put subtle skin details back into the image; Detail Size determines the maximum size of details you want to put back into the face, and Detail is a sharpening operation that lets you adjust how visible these small details are. By combining smoothing and subtle preservation of small details, you can get a much more naturalistic result than were you to simply leave the entire face unnaturally smooth.

(Top) The original image, (Bottom Left) Only smoothing complexion, (Bottom Right) Using Detail Size and Detail to put natural texture back into the smoothed result (results exaggerated for print)

Beauty Advanced

These controls are identical to the Advanced controls of the Beauty plug-in, covered previously in this chapter.
Color Grading

These controls let you make color adjustments to the overall face.

- **Contrast**: This slider lets you lighten the face in a natural way by keeping the shadows dark even while you brighten the face, making it easy to bring actors out of the background.
- **Midtone**: Lets you add a more luminous quality to the skin tone.
- **Color boost**: Specifically boosts saturation in the lowest saturated parts of the face.
- **Tint**: Provides a limited range of naturalistic hues emphasizing orange through red (but extending to green and magenta) with which to tweak complexion.
- **Desaturate shadow**: This slider lets you selectively desaturate the darkest shadows on the face to keep things looking natural, or to desaturate more aggressively in order to stylize the face in a different way. Also useful when using the other adjustments of this plug-in makes the shadows too colorful. Moving this slider into negative values will add saturation.
- **Shine Removal**: This slider is an inverse contrast adjustment designed to ameliorate sweat and shine on a person’s face, although moving this slider into negative values will also accentuate shine.

Eye Retouching

These controls target just the eyes and surrounding area of the face.

- **Sharpening**: This slider lets you selectively add sharpening just to the eyes and eyelashes, which lets you instantly add focus to any performer.
- **Brightening**: This slider lets you whiten the eyeballs.
- **Eye Light**: This slider lets you brighten the region of the face around the eyes that’s often thrown into shadow by the subject’s forehead in situations with imprudent lighting.
- **Eyebag Removal**: This slider uses a variety of techniques to smooth, color-adjust, and brighten the area under the eyes most susceptible to eye bags with tired talent.

(Lef) Eyes with no special adjustment, (Right) Eyes with adjustment

Lip Retouching

These controls target just the lips and surrounding area of the mouth.

- **Hue**: This slider lets you adjust the color of a subject’s lips or lipstick.
- **Saturation**: This slider lets you adjust the intensity of lip color.
- **Upper Lip Smooth**: Lets you smooth out fine age lines that can appear above lips.
Blush Retouching
The parameters in this group let you modify the hue of the blush region of a subject’s cheek, letting you correct an unwise makeup choice, or push a subject’s blush color around to add makeup that wasn’t there.

– **Hue:** This slider lets you adjust the hue of the cheeks.
– **Saturation:** This slider then lets you intensify or remove blush color.
– **Size:** This slider lets you adjust the size of the blush area of the cheeks.

About Forehead, Cheek, and Chin Retouching
The next three groups of controls borrow a technique from portrait painters, who’ve long taken advantage of the “traffic light” approach to rendering skin hues, that observes that foreheads are often a bit yellow, the middle of the face is usually a bit red, and chins can be a bit green. A combination of unequal sun exposure, capillary distribution, and follicle growth account for this, but the bottom line is that faces are seldom a single unified hue. This means that there may be a region of the face that would benefit from individual adjustment (cheeks that have gotten too much sun, for example). But it also means that when you allow a bit of hue variation into your face grade, you can achieve a more naturalistic result.

(Left) A face graded with a single hue, (Right) A face graded with slight variation in the forehead, blush area, and chin

**TIP:** For a variety of reasons, people are extremely sensitive to the hues of skin tone, so tiny variations that can be difficult to identify nevertheless have a significant impact on the resulting visuals. Unless you’re aiming to create a special effect, these controls are meant to be used sparingly.
Forehead Retouching
As the name implies, adjusts color and texture on the forehead.

– **Hue and Saturation**: These sliders let you adjust forehead color.

– **Smooth**: This slider lets you apply a specific smoothing operation to the forehead to ameliorate wrinkles and worry-lines.

Cheek Retouching
Simple color adjustment controls affecting the entire cheek area, and not just the blush area.

– **Hue and Saturation**: These sliders let you adjust the color of the cheek, eye, and nose area.

Chin Retouching
Simple color adjustment controls over the chin of the face.

– **Hue and Saturation**: These sliders let you adjust the color of the chin, running up alongside the sides of the face (the beard area).
Chapter 160

Resolve FX Revival

This category consists of plug-ins that let you fix common technical, damage, and quality problems that bedevil programs being finished, remastered, or restored.

Contents

Automatic Dirt Removal (Studio Version Only) 3055
Main Controls 3055
Fine Controls 3056
Chromatic Aberration (Studio Version Only) 3056
Dead Pixel Fixer (Studio Version Only) 3057
General 3057
Patch Type 3058
Patch Options 3058
Advanced Controls 3059
Deband (Studio Version Only) 3059
Deband Parameters 3060
Deflicker (Studio Version Only) 3060
Main Parameters 3060
Isolate Flicker 3061
Speed Optimization Options 3061
Restore Original Detail After Deflicker 3061
Output 3062
Dust Buster (Studio Version Only) 3062
General 3062
Patch Type 3063
Patch Options 3064
Advanced Controls 3064
Noise Reduction (Studio Version Only) 3064
Temporal NR Controls 3064
Temporal Threshold Controls 3065
Automatic Dirt Removal
(Studio Version Only)

The Automatic Dirt Removal plug-in uses optical flow technology to target and repair temporally unstable bits of dust, dirt, hair, tape hits, and other unwanted artifacts that last for one or two frames and then disappear. All repairs are made while maintaining structurally consistent detail in the underlying frame, resulting in a high quality restoration of the image. Fortunately, despite its sophistication, this is a relatively easy plug-in to use; just drop the plug-in on a shot, adjust the parameters for the best results, and watch it go.

(Left) Original image, (Right) Using Automatic Dirt Removal

NOTE: This plug-in is less successful with vertical scratches that remain in the same position for multiple frames and is completely ineffective for dirt on the lens that remains for the entire shot.

Main Controls

The primary controls used to adjust how much dirt is removed from the image.

– **Motion Estimation Type:** Lets you choose from among None, Faster, Normal, and Better. This tunes the tradeoff between performance and quality.

– **Neighbor Frames:** Lets you choose how many frames to compare when detecting dirt. Choosing more frames of comparison takes longer to process, but usually results in finding more dirt and artifacts.
− **Repair Strength:** This slider lets you choose how aggressively to repair dirt and artifacts that are found. Lower settings may let small bits through that may or may not be actual dirt, while higher settings eliminate everything that’s found.

− **Dirt Size Threshold:** This slider lets you tune how large a detected bit of dirt must be to be removed. Raising this parameter lets you omit things like film grain from the operation but may allow smaller bits of dirt through.

− **Show Repair Mask:** This checkbox lets you see the dirt and artifacts that are detected by themselves, so you can see the effectiveness of the results as you fine tune this filter.

### Fine Controls

These controls let you fine tune the effect in an effort to perfect the tradeoff between removing dirt successfully and preserving true image detail.

− **Motion Threshold:** This slider lets you choose the threshold at which pixels in motion are considered to be dirt and artifacts. At lower values more dirt may escape correction, but you’ll experience fewer motion artifacts. At higher values, more dirt will be eliminated, but you may experience more motion artifacts in footage with camera or subject motion.

− **Edge Ignore:** This slider lets you exclude hard edges in the picture from being affected by dirt or artifacts that are removed. Higher values omit more edges from being affected.

### Chromatic Aberration (Studio Version Only)

A Revival category plug-in that lets you manually correct the slight color fringing that results from chromatic aberration in a lens. “Estimated Red/Blue Fringes” checkboxes display an “alignment guide” that visually isolates each of two types of fringing against gray.

(Left) The original image in close up, showing chromatic aberration, (Right) The image with Estimated Red Fringes enabled, letting you see the specific problems as differences between red and cyan stripes

This makes it easy to make manual adjustments to correct the problem, using the Scale and Edge controls to individually adjust Red/Cyan and Blue/Yellow fringing.

(Left) The original image in close up, showing chromatic aberration as a cyan fringe along the right of the smokestack and as a red fringe along the closest corner of the building, (Right) The corrected image in close up; this fringe is gone
Advanced Options provide additional parameters for problem shots. Center X and Y parameters let you offset the center of the lens if you’re dealing with a reframed and re-rendered shot. Balance parameters can help exaggerate hard-to-see fringing to make it easier to correct, and the Fringe Magnification parameter enlarges the fringe indicators that are displayed when you turn on either of the Estimated Fringes checkboxes.

**Dead Pixel Fixer (Studio Version Only)**

If you have clips that were shot on a camera with one or more “dead” or “stuck” pixels in the sensor, you may have black or white spots that are fixed in place in the image. This filter is designed to let you place patches on each dead or stuck pixel, identifying them so you can use different methods of fixing the problem.

In many respects, the Dead Pixel Fixer is similar to the Dust Buster, however the Dust Buster effect is designed to repair transient bits of dust and dirt that only last for a frame or two, whereas the Dead Pixel Fixer is designed to work on blemishes that are fixed in place for the duration of a clip.

To fix dead or stuck pixels, apply the Dead Pixel Fixer filter, make sure the OFX onscreen controls are enabled in the viewer, and then click on each pixel you need to fix with the mouse to place a patch on it. You can click anywhere on the image to place as many patches as you like, there’s no limit. You can also Option-click to delete patches you no longer need. To move any patches, simply drag it to another location.

![Multiple dead pixel removal patches](image)

When you place multiple patches, you can click to select whichever patches you want to adjust the controls for. Each patch can have different control settings.

**General**

These top level controls let you choose how to draw patches with which to repair blemishes in the frame, whether or not to show their on-screen controls, and how.

- **Patch Style**: There are three different kinds of patches you can draw to deal with different kinds of blemishes in the frame.
  - **Draw Rect**: Click and drag to place a rectangular patch of any size from one corner to the opposite corner. Once drawn, you can click on any edge of the overlay and drag to reposition it.
  - **Draw Ellipse**: Click and drag to place an elliptical patch of any size from one corner to the opposite corner. Once drawn, you can click on any edge of the overlay and drag to reposition it.
  - **Place Patch**: Lets you place small patches specifically for tiny details such as dead pixels. When you choose this option, a New Patch Size slider appears that lets you adjust the size of the patches you’re about to place prior to placing them. Once drawn, you can click on the edge of any patch and drag to reposition it.
– **New Patch Size**: (only when Place Patch is selected) Lets you choose how large of a patch to place using the Place Patch tool.

– **Show Patches**: This checkbox lets you show or hide the onscreen outline of every patch in the Viewer.

– **Hide During Interaction**: Hides the onscreen outline of every patch in the Viewer while you’re moving a patch; this makes it easier to see the effect of moving the patch on the image, without the outline getting in the way.

**Patch Type**

There are three methods you can use to attempt to fix the contents of a selected patch. When drawing new patches, the currently selected Patch Type will determine what the next patch will be. When you’ve selected an existing patch, changing the Patch Type will change how that patch works.

– **Spatial**: Automatically fills the interior of the selected patch with pixels drawn from the surroundings of the patch, using the Fill Method. This works well for small blemishes, but for large blemishes a pattern might be discernible, which gives away the effect.

– **Clone**: Clone mode copies part of the image to fill a shape or patch placed over the thing you want to remove. In this mode, clicking and dragging to place a Rect or Ellipse over an imperfection is followed by a second click to place the sample region you want to clone. Clicking once to place a Patch will be followed by a second click to place the sample region. Selecting an existing shape or patch and choosing Clone lets you click on the shape to position the clone region. The sample region is indicated by a dotted shape that’s connected to the original shape.

– **Blend Clone**: Operates similarly to Clone mode, except the copied part of the image that fills the Rect, Ellipse, or Patch is blended with the image to integrate it more softly.

– **Fill Method**: When using the Spatial Patch Type, the fill method determines how the blemish in the image is repaired.

  – **Grid**: Samples the pixels surrounding the Rect, Ellipse, or Patch, and blurs them inward both horizontally and vertically. Extremely effective for tiny blemishes. For larger blemishes, a grid-like pattern may emerge.

  – **Horizontal**: Samples the pixels to the left and right of the Rect, Ellipse, or Patch, and blurs them inward.

  – **Vertical**: Samples the pixels to the top and bottom of the Rect, Ellipse, or Patch, and blurs them inward.

  – **Patchy**: Samples pixels from all around the Rect, Ellipse, or Patch, and expands and blurs them together to create a soft, non-uniform region with which to repair the blemish. Doesn’t have the patterning of the grid methods of fill, but produces an extremely smooth result.

  – **Smooth**: Simply uses a gaussian blur to repair the blemish.

**Patch Options**

These options let you customize the effect of a patch filling over a blemish.

– **Mute**: Lets you turn a particular patch on or off via keyframing. Useful for blemishes that only show up for a few pixels of a shot.

– **Variability**: (Spatial patches only) Raising this parameter lets you make the Fill Method less uniform.

– **Soft Edges**: Lets you soften the edges of the patch.

– **Size Adjust**: Lets you change the size of a patch after its creation.
Advanced Controls

These controls let you customize the UI of this effect.

- **Clone Sticks to Mouse**: When enabled, drawing or placing a Rect, Ellipse, or Patch in Clone or Blend Clone mode immediately switches to positioning the sample region, making it faster to use.

- **New Patches Stay Selected**: When enabled, patches stay selected after you draw them, in preparation for further customization.

- **UI Line Thickness**: Lets you choose how thick the on-screen outlines should be.

- **Patches Stick to**: This parameter lets you deal with fixing dead pixels or blemishes on clips that have been stabilized.
  
  - **Source**: Patches you place stay put, unless you apply motion stabilization to the shot, in which case the patches are transformed along with the image so they remain “stuck” to the feature in the source clip they’re fixing.
  
  - **Scene**: If you’re eliminating a blemish on a moving subject, you can use the FX Tracker to track the thing you’re fixing, so the patch follows along with it.

- **Output Mode**: This lets you see different representations of the patched effect you’re creating. There are four options.
  
  - **Patched Result**: The final result, with each patch repairing the blemish it’s covering.
  
  - **Patch Locations**: Shows a key where each placed patch is white against black.
  
  - **Differences**: Shows the difference of each patch against the original image.
  
  - **Difference Magnitude**: Shows a more pronounced Differences representation.

Deband *(Studio Version Only)*

Low bit-depth media that has areas with shallow gradients of color, such as a sky or a wall, often exhibit color banding, seen as visible stripes, because there aren’t enough color values to smoothly represent the gradation from light blue to darker blue in the sky.

![An example of banding in the sky of an image](image)

This filter is designed to isolate the edges of color banding and minimize them by dithering pixels from either side to soften the transition. This filter works best when applied to regions of the image that have been isolated with a secondary qualifier or window, otherwise you risk all edges within your image being dithered and thus softened (although this can be an interesting stylistic effect).
Deband Parameters

Deband controls include:

- **Edge Threshold:** Adjusts how well-defined an edge needs to be in order to be affected by this filter; lowering this excludes fainter edges, while raising this includes them.
- **Radius:** Lowers or raises the intensity of dithering in areas that will be affected.
- **Post Refine:** Narrows (by lowering) or widens (by raising) the areas affected by dithering.
- **Display Edge:** A checkbox that shows you a black and white high-contrast preview of which edges are being detected for dithering, which can help you fine-tune your results.

Deflicker *(Studio Version Only)*

Introduced in DaVinci Resolve 15, this plug-in replaces the previous Timelapse Deflicker filter, and solves a far broader variety of problems in a much more automatic way. The new Deflicker plug-in handles such diverse issues as flickering exposure in timelapse clips, flickering fluorescent lighting, flickering in archival film sources, and in certain subtle cases even the “rolling bars” found on video screens shot with cameras having mismatched shutter speeds. Two key aspects to this filter are that it only targets rapid, temporally unstable variations in lightness, and that it’s able to target only the areas of an image where flickering appears, leaving all other parts of the image untouched. As a result, this plug-in can often repair problems once considered “unfixable.”

Main Parameters

By default, the top section of this plug-in exposes a single control, which in many cases may be all you need.

- **Deflicker Setting pop-up menu:** The top two options, Timelapse and Fluoro Light, are presets that effectively eliminate two different categories of flickering artifacts. If neither of these presets is quite as effective as you’d hoped, a third option, Advanced Controls, opens up the Isolate Flicker controls at the heart of this plug-in to let you tailor it further to your needs.
**Isolate Flicker**

Hidden by default, these controls only appear when you set Deflicker Setting to Advanced Controls, and let you choose how to detect motion in the scene so that flickering may be correctly addressed relative to the motion of subjects and items within the frame where it appears.

- **Mo.Est. Type:** Picks the method DaVinci Resolve uses to analyze the image to detect motion. Despite the names of the available options, which options will work best is highly scene dependent. The default, Faster, is less processor intensive, but less accurate, however this can be an advantage and actually do a better job with high detail images that would confuse the Better option. Choosing Better is more accurate, but more processor intensive, and Better will try harder to match fine details which can sometimes cause problems. None lets you disable motion analysis altogether, which can work well (and will be considerably faster) in situations where there’s no motion in the scene at all. The default is Better.

- **Frames Either Side:** Specifies the number of frames to analyze to determine what’s in motion. Higher values are not always better; the best setting is, again, scene dependent. The default is 3.

- **Motion Range:** Three settings, Small, Medium, and Large, let you choose the speed of the motion in the frame that should be detected.

- **Gang Luma Chroma:** Lets you choose whether to gang the Luma and Chroma Threshold sliders or not.

- **Luma Threshold:** Determines the threshold above which changes in luma will not be considered flicker. The range is 0–100, 0 deflickers nothing, 100 applies deflickering to everything. The default is 100.

- **Chroma Threshold:** Determines the threshold above which changes in chroma will not be considered flicker. The range is 0–100, 0 deflickers nothing, 100 applies deflickering to everything. The default is 100.

- **Motion Threshold:** Defines the threshold above which motion will not be considered flicker.

**Speed Optimization Options**

Closed by default, opening this control group reveals two controls:

- **Reduced-Detail Motion checkbox:** On by default, reduces the amount of detail that’s analyzed to detect flicker. In many cases, this setting makes no visible difference but increases processing speed. Disable this setting if your clip has fine detail that is being smoothed too aggressively.

- **Limit Analysis Area checkbox:** Turning this on reveals controls over a sample box that you can use to limit deflickering to a specific region of the image. This option is useful when (a) only one part of the image is flickering, so focusing on just that area speeds the operation considerably, or (b) part of the image is being smoothed too much by deflickering that’s fixing another part of the image very well.

**Restore Original Detail After Deflicker**

Closed by default, opening this control group reveals two controls:

- **Detail to Restore slider:** Lets you quickly isolate grain, fine detail, and sharp edges that should not be affected by the deflicker operation, preserving those fine details exactly.

- **Show Detail Restored checkbox:** Turning this checkbox on lets you see the edges that are detected and used by the Detail to Restore slider, to help you tune this operation.
Output

The Output pop-up menu lets you choose what Deflicker outputs, with options to help you troubleshoot problem clips. Here are the available options:

- **Deflickered Result**: The final, repaired result. This is the default setting.
- **Detected Flicker**: This option shows you a mask that highlights the parts of the image that are being detected as having flickering, to help you evaluate whether the correct parts of the image are being targeted. This mask can be very subtle, however.
- **Magnified Flicker**: This option shows you an exaggerated version of the Detected Flicker mask, to make it easier to see what the Deflicker plug-in is doing.

Dust Buster (Studio Version Only)

This plug-in is also designed to eliminate dust, dirt, and other imperfections and artifacts from clips, but it does so only with user guidance, for clips where the Automatic Dirt Removal plug-in yields unsatisfactory results. This guidance consists of moving through the clip frame-by-frame and drawing boxes around imperfections you want to eliminate. Once you've drawn a box, the offending imperfection is auto-magically eliminated in the most seamless way possible. This works well for dirt and dust, but it also works for really big stains and blotches, as seen below.

![Image of Dust Buster](image1)

In many respects, the Dust Buster is similar to the Dead Pixel Fixer, however the Dust Buster effect is designed to repair transient bits of dust and dirt that only last for a frame or two, whereas the Dead Pixel Fixer is designed to work on blemishes that are fixed in place for the duration of a clip.

General

These top level controls let you choose how to draw patches with which to repair temporally unstable dust and dirt in the frame, whether or not to show their on-screen controls, and how.

- **Navigation Controls**: Four buttons let you jump to frames on which you've drawn patches. There are four buttons:
  - **First Modified Frame**: Jumps the playhead to the first frame of that clip with a patch.
  - **Last Modified Frame**: Jumps the playhead to the last frame of that clip with a patch.
  - **Next Modified Frame**: Jumps the playhead to the next frame forward with a patch.
  - **Last Modified Frame**: Jumps the playhead to the last frame back with a patch.
- **Patch Style**: There are three different kinds of patches you can draw to deal with different kinds of blemishes in the frame.
  - **Draw Rect**: Click and drag to place a rectangular patch of any size from one corner to the opposite corner. Once drawn, you can click on any edge of the overlay and drag to reposition it.
– **Draw Ellipse**: Click and drag to place an elliptical patch of any size from one corner to the opposite corner. Once drawn, you can click on any edge of the overlay and drag to reposition it.

– **Place Patch**: Lets you place small patches specifically for tiny details such as dead pixels. When you choose this option, a New Patch Size slider appears that lets you adjust the size of the patches you’re about to place prior to placing them. Once drawn, you can click on the edge of any patch and drag to reposition it.

– **New Patch Size**: (only when Place Patch is selected) Lets you choose how large of a patch to place using the Place Patch tool.

– **Show Patches**: This checkbox lets you show or hide the onscreen outline of every patch in the Viewer.

– **Hide During Interaction**: Hides the onscreen outline of every patch in the Viewer while you’re moving a patch; this makes it easier to see the effect of moving the patch on the image, without the outline getting in the way.

### Patch Type

There are six methods you can use to attempt to fix the contents of a selected patch. When drawing new patches, the currently selected Patch Type will determine what the next patch will be. When you’ve selected an existing patch, changing the Patch Type will change how that patch works.

– **Auto**: The default method. Once you’ve drawn a bounding box, the two frames prior to and the two frames after the current clip will be analyzed and compared to the current image. The best of these 5 frames will be sampled to remove the imperfection in the current frame. Images two frames away are prioritized since that will avoid the appearance of frozen grain, but only if they’re a suitable match to the content of the current frame.

– **+/- 1 Frame**: In this mode, if you draw a bounding box from left to right, the next frame will be drawn upon to remove the imperfection. If you draw a bounding box from right to left, the previous frame will be used.

– **+/- 2 Frames**: If you draw a bounding box from left to right, the image two frames forward will be drawn upon to remove the imperfection. If you draw a bounding box from right to left, the image two frames back will be used.

– **Spatial**: Automatically fills the interior of the selected patch with pixels drawn from the surroundings of the patch, using the Fill Method. This works well for small blemishes, but for large blemishes a pattern might be discernible, which gives away the effect.

– **Clone**: Clone mode copies part of the image to fill a shape or patch placed over the thing you want to remove. In this mode, clicking and dragging to place a Rect or Ellipse over an imperfection is followed by a second click to place the sample region you want to clone. Clicking once to place a Patch will be followed by a second click to place the sample region. Selecting an existing shape or patch and choosing Clone lets you click on the shape to position the clone region. The sample region is indicated by a dotted shape that’s connected to the original shape.

– **Blend Clone**: Operates similarly to Clone mode, except the copied part of the image that fills the Rect, Ellipse, or Patch is blended with the image to integrate it more softly.

– **Fill Method**: When using the Spatial Patch Type, the fill method determines how the blemish in the image is repaired.

  – **Grid**: Samples the pixels surrounding the Rect, Ellipse, or Patch, and blurs them inward both horizontally and vertically. Extremely effective for tiny blemishes. For larger blemishes, a grid-like pattern may emerge.

  – **Horizontal**: Samples the pixels to the left and right of the Rect, Ellipse, or Patch, and blurs them inward.
– **Vertical**: Samples the pixels to the top and bottom of the Rect, Ellipse, or Patch, and blurs them inward.

– **Patchy**: Samples pixels from all around the Rect, Ellipse, or Patch, and expands and blurs them together to create a soft, non-uniform region with which to repair the blemish. Doesn’t have the patterning of the grid methods of fill, but produces an extremely smooth result.

– **Smooth**: Simply uses a gaussian blur to repair the blemish.

**Patch Options**

These options let you customize the effect of a patch filling over a blemish.

– **Mute**: Lets you turn a particular patch on or off via keyframing. Useful for blemishes that only show up for a few pixels of a shot.

– **Variability**: (Spatial patches only) Raising this parameter lets you make the Fill Method less uniform.

– **Soft Edges**: Lets you soften the edges of the patch.

– **Size Adjust**: Lets you change the size of a patch after its creation.

**Advanced Controls**

These controls let you customize the UI of this effect.

– **Clone Sticks to Mouse**: When enabled, drawing or placing a Rect, Ellipse, or Patch in Clone or Blend Clone mode immediately switches to positioning the sample region, making it faster to use.

– **New Patches Stay Selected**: When enabled, patches stay selected after you draw them, in preparation for further customization.

– **UI Line Thickness**: Lets you choose how thick the on-screen outlines should be.

– **Output Mode**: This lets you see different representations of the patched effect you’re creating. There are four options.

  – **Patched Result**: The final result, with each patch repairing the blemish it’s covering.

  – **Patch Locations**: Shows a key where each placed patch is white against black.

  – **Differences**: Shows the difference of each patch against the original image.

  – **Difference Magnitude**: Shows a more pronounced Differences representation.

**Noise Reduction (Studio Version Only)**

Based on the Noise Reduction controls in the Color page, the Resolve FX Noise Reduction is divided into two types of GPU-accelerated noise reduction designed to subdue noise in problematic clips. Both methods of noise reduction can be used separately or together, in varying amounts depending on the needs of the particular material you’re working on.

**Temporal NR Controls**

The Temporal NR controls analyze images across multiple frames to isolate noise from detail. Motion estimation settings let you exclude moving subjects from this operation to prevent unwanted motion artifacts.
Frames Either Side: The number of frames on either side of the current frame that you want averaged to separate detail from the noise. You can choose between 0 and 5 frames. 0 applies no frame averaging; higher values apply more frame averaging, at the expense of being significantly more computationally intensive. A higher frame setting may yield a better analysis, but may also yield unwanted artifacts if there are fast-moving images in the frame. A value of 1 may yield better results for fast-moving images. If you need to use higher frame values, but see artifacts, you can also try adjusting the Motion Threshold to fix the issue.

Motion Est. Type: Picks the method DaVinci Resolve uses to detect motion in the image. The default, Faster, is less processor intensive, but less accurate. Choosing Better can effectively exclude motion more accurately, but is more processor intensive. None lets you disable motion estimation altogether, resulting in the application of Temporal NR to the entire image.

Motion Range: Three settings, Small, Medium, and Large, let you set the speed of motion that Motion Estimation should expect to exclude. A Small setting assumes slow-moving subjects with little or no motion blur, allowing Temporal NR to affect more of the image at a given Motion Threshold setting. A Large setting assumes fast motion with blur occupying a larger area of the image, which excludes more of the image from Temporal NR at the same Motion Threshold setting. Choose the setting that gives you the best compromise between reducing noise and the introduction of motion artifacts when adjusting the Motion Threshold parameter.

Temporal Threshold Controls

The Temporal Threshold parameters allow you to control which image characteristics get more or less noise reduction.

Luma Threshold: Lets you determine how much or how little Temporal NR to apply to the luma component of the image. The range is 0–100, where 0 applies no noise reduction at all, and 100 is the maximum amount. Too high a setting may eliminate fine detail from the image.

Chroma Threshold: Determines how much Temporal NR is applied to the chroma component of the image. The range is 0–100, where 0 applies no noise reduction at all, and 100 is the maximum amount. Too high a setting may eliminate fine color detail from the image. However, you may find you can raise the Chroma Threshold higher than the Luma Threshold with less noticeable artifacting.

Gang Luma Chroma: Ordinarily, the Luma and Chroma Threshold parameters are ganged together so that adjusting one adjusts both. However, disabling this checkbox ungangs these parameters, allowing you to adjust different noise reduction amounts to each component of the image, depending on where the noise happens to be worst.

Motion: Defines the threshold separating which moving pixels are in motion (above this threshold) versus which moving pixels are static (below this threshold). Using Motion Estimation, Temporal NR is not applied to regions of the image that fall above this threshold, to prevent motion artifacts by not applying frame-averaging to parts of the image that are in motion. Lower values omit more of the image from Temporal NR by considering more subtle movements. Higher values apply Temporal NR to more of the image by requiring faster motion for exclusion. You can choose between 0 and 100, where 0 applies Temporal NR to no pixels, and 100 applies Temporal NR to all pixels. The default value is 50, which is a suitable compromise for many clips. Be aware that if you set too high a Motion Threshold, you may see artifacts in moving parts of the image.

Blend: Lets you dissolve between the image as it’s being affected by the Temporal NR parameters (at 0.0) and the image with no noise reduction (100.0). This parameter lets you easily split the difference when using aggressive temporal noise reduction.
Spatial NR Controls

The Spatial NR controls let you smooth out regions of high-frequency noise throughout the image, while attempting to avoid softening by preserving detail. It’s effective for reducing noise that Temporal NR can’t.

- **Mode:** The Mode drop-down menu lets you switch Spatial NR between three different algorithms. All three modes of operation use the same controls, so you can switch between modes using the same settings to compare your results.

- **Faster:** Uses a computationally lightweight method of noise reduction that’s good at lower settings, but may produce artifacts when applied at higher values.

- **Better:** Switches the Spatial NR controls to use a higher quality algorithm that produces greatly superior results to Faster, at the expense of being more processor intensive to render and not allowing you to decouple the Luma and Chroma Threshold sliders for individual adjustments to each color component.

- **Enhanced:** Does a significantly better job preserving image sharpness and detail when raising the Spatial Threshold sliders to eliminate noise. This improvement is particularly apparent when the Spatial Threshold sliders are raised to high values (what constitutes “high” varies with the image you’re working on). At lower values, the improvement may be more subtle when compared to the “Better” mode, which is less processor intensive than the computationally expensive “Enhanced” setting. Additionally, “Enhanced” lets you decouple the Luma and Chroma threshold sliders so you can add different noise reduction amounts to each color component, as the image requires.

- **Radius:** Options include Large, Medium, and Small. A smaller radius offers greater real-time performance and can provide good quality when using low Luma and Chroma Threshold values. However, you may see more aliasing in regions of detail when using low NR Threshold values.

Setting Radius to be progressively larger results in higher quality within areas of greater visual detail at high Luma and Chroma Threshold values, at the expense of slower performance. An NR Radius of Medium should provide suitable quality for most images when using medium NR Threshold settings. As with many operations, there’s an adjustable tradeoff between quality and speed.

Spatial Threshold Controls

The Spatial Threshold parameters allow you to control which image characteristics get more or less noise reduction.

- **Luma:** Lets you determine how much or how little noise reduction to apply to the luma component of the image. The range is 0–100, where 0 applies no noise reduction at all, and 100 is the maximum amount. Too high a setting may eliminate fine detail from the image.

- **Chroma:** Lets you determine how much or how little noise reduction to apply to the chroma component of the image by smoothing out regions of high-frequency noise while attempting to preserve the sharpness of significant edge details. The range is 0–100, where 0 applies no noise reduction at all, and 100 is the maximum amount. Too high a setting may eliminate fine color detail from the image. However, you may find you can raise the Chroma Threshold higher than the Luma Threshold with less noticeable artifacting.

- **Gang Luma Chroma:** Ordinarily, the Luma and Chroma Threshold parameters are ganged together so that adjusting one adjusts both. However, you can ungang these parameters to adjust different amounts of noise reduction to each component of the image. For example, if an image softens too much at a certain level of noise reduction, but you find more color speckling than luma noise, you can lower the Luma Threshold to preserve detail while raising the Chroma Threshold to eliminate color noise.

- **Blend:** Lets you dissolve between the image as it’s being affected by the Spatial NR parameters (at 0.0) and the image with no noise reduction (100.0). This parameter lets you easily split the difference when using aggressive spatial noise reduction.
Global Blend

- **Blend**: Lets you dissolve between the image with no noise reduction (1.0) and the image with both Spatial NR and Temporal NR at their current settings (0.0).

Using Noise Reduction

The following procedure suggests a method of using the Noise Reduction (NR) parameters to achieve a controlled result.

**Applying noise reduction to an image:**

1. Enable Temporal NR by choosing 1 to 5 frames from the Number of Frames pop-up menu. Keep in mind that more frames dramatically increase the render time of this effect, while it may or may not significantly improve the result, depending on your material.

2. Choose options from the Motion Est. Type and Motion Range drop-down menus corresponding to how much motion is in the image. If there’s a lot of motion, you may need to choose Better and Large. If there’s not very much motion, lesser settings may suffice.

3. With Luma and Chroma Threshold linked, slowly raise either parameter until you just start to see a reduction in noise within nonmoving areas. Then make smaller adjustments to determine the maximum amount you can add without creating artifacts or overly softening detail.

4. If there’s obviously more chroma than luma noise in the image, you can disable Luma/Chroma linking at a satisfactory level of luma noise reduction, and then raise the Chroma Threshold to address color speckling in the picture.

5. Suppose you’re not satisfied with the tradeoff between the maximum possible threshold of noise reduction and the prevention of motion artifacts. In that case, you may want to adjust the Motion Threshold setting, lowering it to omit more of the motion from the noise reduction operation, or raising it to include more motion. If you’re still not satisfied, you can also try better Motion Est. Type and Motion Range settings.

   Keep in mind that the strength of Temporal NR is to reduce noise in unmoving parts of the image. When you’ve achieved the best tradeoff between noise reduction in the still areas and avoidance of motion artifacts in the moving areas of the image, it’s time to turn to Spatial NR to further eliminate noise throughout the rest of the picture.

6. Enable Spatial NR by raising either the Luma or Chroma Threshold parameters, which are linked by default, until you strike a suitable balance between the reduction of noise and an unwanted increase in image softness.

7. It’s recommended to choose the Enhanced option from the Spatial NR mode pop-up, as it will yield the best possible results. However, this can be processor-intensive, so if you need better real-time performance, you can switch the mode to Faster and compare results.

8. If there’s obviously more chroma than luma noise in the image, you can disable Luma/Chroma linking at a satisfactory level of luma noise reduction, and then raise the Chroma Threshold to apply more aggressive Spatial NR to address color speckling in the picture.

9. If you’ve had to use a high Spatial NR Luma or Chroma Threshold setting to reduce noise visibly, and areas of detail look a bit chunky or aliased, you can choose a larger setting from the Radius pop-up menu to enable a more detailed analysis of the scene.

   This will result in higher visual quality, but larger NR Radius settings are more processor-intensive and may reduce real-time performance if you don’t have adequate GPU resources available to your system.

10. If you’ve found suitable noise reduction settings, but the result is too aggressive and makes the image appear too processed, you can try raising the Spatial NR and/or Temporal NR Blend parameters to fade between the noise reduction added by each set of controls, and the image as it was before you added noise reduction.
Try Applying Temporal NR First, then Applying Spatial NR

Because Temporal NR analyzes multiple frames for its noise isolation, it tends to be better at preserving detail accurately in regions of the image where there’s little motion. If you try applying Temporal NR first and get a successful result, even if only in part of the image, you may reduce how much Spatial NR you have to apply, thus improving the overall quality of your final result.

Keep in mind that while Temporal NR does a great job in unmoving parts of an image but is less effective when dealing with subjects in motion, Spatial NR can reduce noise everywhere in the frame falling below its threshold, even when there’s motion. Ultimately, a combination of the two is almost always going to be a winning combination.

Spatial NR Radius, How Large Should You Go?

Larger NR Radius settings can dramatically improve the quality of high-detail regions in shots where you’re using aggressive Spatial noise reduction, but it’s not necessary to always jump to the large Radius setting, which provides the highest precision. In many cases, when evaluating an image that you’re applying noise reduction to, you may not be able to perceive the additional quality. You’ll waste processing time on an unnecessary level of correction.

It’s a good idea to evaluate the full-frame image on a large enough display to see the noise you’re working on within the viewing context of the intended audience. Zooming really far into a clip while applying noise reduction may encourage you to use higher quality settings than are necessary because an excessively enlarged detail of an image lets you see subtle changes that you wouldn’t notice at actual size.

Object Removal (Studio Version Only)

A Revival category plug-in that’s best used in the Color page, Object Removal uses the DaVinci Neural Engine to attempt to remove an object in the frame as automatically as possible. This plug-in works best when removing a moving object that passes over a temporally stable background, or dirt on the lens of a shot where the camera is in motion. Smaller objects get better results than larger objects, but your results really depend on the footage. Here’s a simple procedure that shows how to do this.

To remove a moving object from a clip:

1. In this example, a drone is flying through a long shot that’s being simultaneously recorded. We’ll remove the drone using a window to identify the feature to be removed using the Object Removal plug-in.

   ![The original shot with a drone that needs to be removed](image)

2. Use the Window palette to draw a window around the object that needs to be removed. You’ll get the best results using windows or masks that hug the feature being removed fairly closely.

In simple cases, it’s often easiest to apply the Object Removal effect to a Corrector node, so you can use a window or qualifier within that node to isolate the feature you want to remove. That’s what we’ll do in this example.
3 Track or keyframe the window to move with the feature you’re removing. Again, you’ll get better results the closer your window hugs the object being removed, and it’s good to have some softness at the edge of this window.

4 Drag and drop the Object Removal plug-in onto the node in which you’ve just isolated the feature to be removed.

5 The “Use OFX Alpha” option will be activated automatically in the node’s contextual menu to enable the Object Removal plug-in to use whatever key has been created within that node to do its work.

6 Click the Scene Analysis button, and wait for the analysis to finish. If the object you’re removing is moving but the camera is locked, you can turn on the “Assume No Motion” checkbox to improve your results in this case.

   If your footage is ideal for object removal, the object will disappear once analysis is complete, replaced by a seamless background derived from detail found on neighboring frames.

The Object Removal plug-in is highly footage dependent, and you won’t always get this good a result this easily. Problems with the result are shown via gray, either gray fringing or solid gray filling the replacement window. Gray shows you where the current settings are failing to find background content with which to fill in the patch you’re removing. If this happens, there are two things you can try.

   – If you notice while playing through the analyzed result that the object removal mask has gray fringing on some frames, you can try adjusting the “Search Range” slider, which is the distance, in frames, from the current frame that the Object Removal plug-in is searching for replacement image detail. For example, if the Search Range is 20, it searches +/-20 frames from the current location, or 40 frames total. The allowance of 10 frames means we look at every 4th frame. You will generally get the best results for the smallest range that gives an acceptable result.

   – If you’re noticing that the object removal mask is filled entirely with gray on some frames, this means that background fill couldn’t be easily generated for those frames. In this case, you can try clicking the “Build Clean Plate” button, which takes a “best guess” approach to generating a background with which to fill the frame and integrates this with frames that could be successfully filled in.
– If the patch is successfully filled, but the result isn’t blending well with the background, you can try changing the Blend mode. The default is Linear, which is a simple cloning operation, but you can also choose Adaptive Blend, which can provide better results except in certain situations where the edges of the replacement patch have a different color or brightness than the background.

– The Scene Mode drop-down menu provides different methods of analyzing the scene, for improving the analysis of how the area that needs to be replaced moves, to best determine how to fill the hole left by the object being removed. Background analyzes the entire image except for the object region. Boundary analyzes the boundary area surrounding the object region. Object is for analyzing an object that moves with the background, like a sticker that’s on a window while the camera moves.

**Patch Replacer (Studio Version Only)**

The Patch Replacer is a quick fix when you need to “paint out” an unwanted feature from the image. For those of you who’ve been using windows and Node Sizing to do small digital paint jobs, this plug-in offers more options and a streamlined workflow.

On adding the plug-in, an onscreen control consisting of two oval patches appears, with an arrow connecting them indicating which patch is being copied into the other. The oval to the left is the “source” patch, used to sample part of the image, and the oval to the right is the “target” patch, used to cover up the unwanted feature using pixels from the source patch.

To use the Patch Replacer, simply drag the target patch over the feature you want to obscure, resize it to fit using the corner controls (the source patch is automatically resized to match), and then drag the source patch to an area of the image that can convincingly be used to fill the target patch.

(Left) Original image, (Right) Removing the thermostat with the Patch Replacer

The source and target patches can be motion tracked using the FX tracker, so this tool is effective even if the subject or camera is moving.

**Main Controls**

The Fill-in Method pop-up menu is arguably the most important, as it defines what method to use to fill the destination patch with whatever is in the source patch. The rest of the primary controls work differently depending on which Fill-in method you choose.

– **Clone**: Simply copies the source patch into the target patch. When Clone is selected, the Replacement Detail slider (which defaults to 1) lets you fade out the source patch, while Region Shape lets you choose a different kind of shape to use, and Blur Shape Edges lets you feather the edge of this operation, to more convincingly blend the source with the target area.
– **Adaptive Blend:** A much more sophisticated method of obscuring the target area using pixels from the source patch, and in many cases will yield better results more quickly than cloning. The source patch is copied into the target patch in such a way as to combine the source detail with the lighting found inside of the target area, creating in most instances a fast, seamless match. The Keep Original Detail checkbox, when turned on, merges detail from the source and target patches to create a composite, rather than a fill. The Blur Shape Edges slider works a bit differently with Adaptive Blend selected, but the idea is the same, feathering the effect from the outside in to obscure instances where there’s a noticeable border around the target area.

– **Fast Mask:** Eliminates the source patch, doing instead a quick neighboring pixel blend that works well with small patches but can betray a grid pattern on larger patches. Region Shape and Blur Shape Edges are both adjustable.

**Patch Positions**

Source X and Y, Target X and Y, and Target Width and Height are provided as explicit controls both for numeric adjustment, should that be necessary, and also to allow for keyframing in case you need to change the position and/or size of the source and fill patches over time.

Keep in mind that the source and target patches can be motion tracked using the FX tracker, although two checkboxes, Source Follows Track and Target Follows Track, let you disable FX tracker match moving when necessary.

**Onscreen Controls**

The Control Visibility pop-up menu lets you choose whether the source and target onscreen controls are visible as you work. Show (the default) leaves all onscreen controls visible all the time. Auto Hide hides all onscreen controls whenever you’re dragging one, letting you see the image as you adjust it without having these controls in the way. Hide makes all onscreen controls invisible, so you can see a clean version of the image with the effect, however you can still edit the effect if you remember where the controls are.
Chapter 161

Resolve FX Sharpen

These plug-ins offer a newer and more detailed method of sharpening specific details in images than the sharpen operation found in the Blur palette. Three different plug-ins offer different ways of using the same fundamental algorithm to perform different tasks.

Contents

**Sharpen (Studio Version Only)**  
Main Controls  3073  
Detail Levels  3073  
Chroma  3073

**Sharpen Edges (Studio Version Only)**  
Main Controls  3073  
Edge Detection Controls  3074

**Soften and Sharpen (Studio Version Only)**  
Main Controls  3074  
Adjust Small Skin Texture Granularity  3075
Sharpen (Studio Version Only)

The Sharpen filter functions by separating the image into four levels of detail, the underlying structure, the fine scale details, the medium scale details, and the large scale details, each of which encompasses differently sized structures that comprise the overall image. In this way, the Sharpen filter lets you apply different amounts of sharpening to each of the fine, medium, and large structures of the image, giving you enormous control over how these different structures of image detail are affected.

Main Controls

Controls the overall sharpening effect.

- **Sharpen Amount**: The primary global control that lets you add sharpening to the image. To refine the result, use the controls in Detail Levels to choose how much sharpness to apply to each size of structure this plug-in can operate upon. 1.800 is the default value. 0 is no sharpening, 5.000 is maximum sharpening.

Detail Levels

Lets you customize the sharpen effect in a variety of highly specific ways.

- **Fine Detail Size**: This slider adjusts the threshold of what is considered to be a fine detail, although this also alters which image structures are affected by the Medium and Large Details sliders as well. Lowering this slider omits larger structures of the image from sharpening. The default is 0.050.

- **Fine Detail**: At its default setting, the Fine Details slider governs the sharpness of extremely fine detail such as skin pores and strands of hair, or small speckles on textured surfaces. Lower settings apply less sharpening to these structures, while higher settings apply more sharpening.

- **Medium Details**: This slider governs the sharpness of coarser detail such as freckles, wrinkles, clusters of hair, and surface details with greater edge definition. Lower settings apply less sharpening to these structures, while higher settings apply more sharpening.

- **Large Details**: This slider governs the sharpness of the largest details in the image, such as eyelids, the shadows at the edges of lips and noses, and the edges where hair meets the face, and the most contrasty edge details throughout the image. Lower settings apply less sharpening to these structures, while higher settings apply more sharpening.

Chroma

A special purpose control that you want to handle with care.

- **Sharpen Chroma**: Selectively sharpens the chroma of the image while leaving the luma (Y) alone.

Sharpen Edges (Studio Version Only)

A variation of the Sharpen filter that’s streamlined for detecting edges to create a key used to limit sharpening to the selected edge details of an image. This is a good filter to use when attempting to make mildly soft-focus clips less objectionable.
Main Controls
Controls the overall sharpening effect accomplished with this plug-in.
- **Sharpen Amount:** The primary global control for adding sharpening to the edges detected by this filter.
- **Sharpen Radius:** Controls the granularity of the detail that's added using Sharpen Amount.

Edge Detection Controls
These controls let you customize the sharpen effect in very specific ways.
- **Display Edges:** This checkbox lets you see a grayscale preview of the edges that are being detected for sharpening while you use the other controls in this group. If you turn this checkbox on, you can see precisely the effect that the four other controls in this section have on the key that determines which parts of the image are sharpened.
- **Pre Denoise:** Smooths the matte to remove individual pixels of noise. Reducing Pre Denoise lets you minimize edges from the key that you don’t want to sharpen and soften edges that are jagged because of excessive noise. Raising Pre Denoise adds more edges to the sharpening operation and strengthens the edges that are already there.
- **Edge Detect Threshold:** Lets you adjust how strong edge detail needs to be in order to be included in the key. Reducing this parameter includes more edges in the operation, while raising it excludes edges from the operation.
- **Edge Mask Strength:** Lets you increase the intensity of the edges in the key. Reducing Edge Mask Strength diminishes the edges and reduces the intensity of sharpening in those areas. Raising Edge Mask Strength intensifies the edges and adds more of the image within the region of each detected edge to the sharpening operation.
- **Edge Blur:** Lets you control the softness of the edges in the key. Reducing Edge Blur sharpens the key and narrows the edges that are affected by sharpening. Increasing Edge Blur softens the key and potentially includes a wider area of image detail in the sharpening operation.

Soften and Sharpen (Studio Version Only)
A variation of the Sharpen filter that’s streamlined for letting you both smooth some details and add sharpness to other details of the image based on the size of the structures. It can be used with any image for which you want to smooth some features while sharpening others, but this is an operation that’s often used for minimizing unwanted blemishes, wrinkles, or scarring when used within a window or qualifier that’s isolating the skin.

The advantage of using Soften and Sharpen is that you can use the Small Texture slider to leave a bit of natural skin detail intact, such as pores and other small naturalistic details, while you use the Medium and Large Texture controls to smooth out unwanted details in whatever proportion gives you a naturalistic result.

**TIP:** The best way to achieve a more natural result is to leave Small Texture at 0 or just above, while reducing Medium Texture just enough to minimize whatever details merit minimizing and reducing Large Texture by somewhat less to minimize larger blemishes, while leaving overall face detail intact. This is the logic behind the default values of Small 0.000, Medium –0.800, and Large –0.300.
Main Controls

Each of the Small, Medium, and Large Texture sliders can be moved into both negative and positive values. A value of 0 means no change is made to the corresponding details of the image. Negative values remove the corresponding details from the image, eventually leaving only the underlying smooth structure of the image at –1.000. Positive values add sharpness to the corresponding details of the image, to a maximum value of 1.000.

– **Small Texture**: Affects extremely fine detail such as skin pores and strands of hair.
– **Medium Texture**: Impacts coarser detail such as freckles, wrinkles, and clusters of hair.
– **Large Texture**: Affects the largest details in the image such as eyelids, eyebrows, the edges of lips and noses, and the edges where hair meets the face.

**TIP**: What’s identifiable as a small, medium, or large structure depends in large part on how the subject of the shot is framed. These structures differ depending on whether you’re grading a subject in a long shot (where they appear small) versus a subject in closeup (where they appear large).

Adjust Small Skin Texture Granularity

This control lets you adjust the distinction between the Small and Medium/Large texture controls in the previous group of controls.

– **Small Texture Size**: Defines the threshold that differentiates Small Textures from Medium and Large Textures, to help you fine-tune the Small Texture that you want to preserve. Raising this value includes more of the image as small details, while lowering this value excludes more of the image from small details.
Chapter 162

Resolve FX Stylize

The plug-ins found in this category all enable different ways of creating artistic modifications to the image.

Contents

**Abstraction** (Studio Version Only)  3077
Main Controls  3077
Quantization Controls  3077
Draw Edge Controls  3077
**Blanking Fill**  3078
Source  3078
Fill Extent  3078
Fill Appearance  3079
Drop Shadow  3079
**Drop Shadow**  3080
**Edge Detect**  3080
**Emboss**  3080
Channels  3080
**Mirrors**  3081
Main Controls  3081
Individual Controls  3081
Rosette Controls  3081
Kaleidoscope Controls  3081
**Pencil Sketch in DaVinci** (Studio Version Only)  3082
**Prism Blur**  3082
**Scanlines**  3082
Appearance  3082
**Color**  3083
Composite  3083
**Stylize** (Studio Version Only)  3083
**Abstraction** *(Studio Version Only)*

A deceptively powerful filter that lets you create a wide range of cartoon-like renders by simplifying an image into adjustable pools of similar color with optional outlines.

**Main Controls**

These controls create the foundation of this effect.

- **Pre Blur:** Simplifies the image by blurring unwanted details prior to this filter taking effect.
- **Abstraction Strength and Iterate Abstraction:** These parameters work together to then smooth the image, creating pools of simplified color within the details of the image.
  - **Abstraction Strength:** Must be higher than 0 for the Iteration No. parameter to have an effect. Higher Abstraction Strength simplifies image detail even more by averaging adjacent regions of color together.
  - **Iterate Abstraction:** Reduces the amount of small detail in the image even further by “widening” adjacent areas of similar color to blend together as one.

**Quantization Controls**

These controls simplify the pools of color even more aggressively by quantizing the bit depth used to stylize the image. The result is an even sharper flattening of each region of color.

- **Quantization:** A checkbox turns this function on.
- **Steps:** Raising this parameter lets you subdivide each region of color into a greater number of separate regions.
- **Softness:** Lets you blur the border between each level of color.

**Draw Edge Controls**

Adds an edge to the regions of color created by this effect.

- **Draw Edge:** Enables edge drawing.
- **Edge Strength:** Raising this value results in thicker and better-defined edges.
- **Edge Detection Threshold:** Raising this value restricts edges to only the boldest edge details in the picture.
Blanking Fill

This plug-in is specifically designed to quickly fill black frame blanking with a stylized image derived from the clip itself, to make blanking less intrusive for viewers in documentaries and news segments. In the following example, the Blanking Fill plug-in is used to add image to the left and right of “pillarboxed” standard definition 4:3 video that appears within a High Definition or Ultra High Definition 16:9 aspect ratio.

![Original standard definition image, Image with default Blanking Fill applied](image)

A variety of controls let you easily customize this effect to suit your own purposes.

**Source**

These controls let you transform the clip in different ways, which also affects how that clip is used to fill the blanking area.

- **Zoom**: Zooms the clip while keeping it within the native domain of definition. Good for quickly cropping unwanted pixels around the edges so they’re hidden and aren’t used for blanking fill.
- **Gang Left/Right Sliders**: On by default, locks both sliders together so moving one moves the other by a mirrored amount.
- **Crop Left and Right**: Crops both the left and right edges of the image and increases the area at the sides with blanking fill.
- **Gang Top/Bottom Sliders**: On by default, locks both sliders together so moving one moves the other by a mirrored amount.
- **Crop Top and Bottom**: Crops both the top and bottom edges of the image and increases the vertical area with blanking fill.

**Fill Extent**

These controls let you choose how the current duplicate of the image is stretched to fill the blanking area.

- **Zoom Mode**: There are three options:
  - **Stretch to Timeline**: Automatically warps the image to stretch it to fit the full frame. Keeps features in the blanking fill area level with where they appear in the original image.
  - **Zoom to Timeline**: Automatically zooms into the image to fit the full frame. Results in the clip looking “inset” from the blanking fill image.
  - **Manual**: Reveals Expand and Aspect sliders that let you manually choose how much to zoom and stretch the image to fit the blanking fill area.
– **Warp Top Layer:** lets you use onscreen controls to choose a section of the edge of an image to stretch out to fill blanking in the frame. In this mode, there are two sets of onscreen controls you can use to customize the result:

A set of outer handles let you choose how far out to warp the edges of the image to fill whatever blanking there is. These default to the project frame size.

A set of inner handles lets you choose how much of the image you want to stretch out. These default to the current title safe boundary. If you customize these, choosing too narrow an edge results in a more extreme warping and stretching effect, while choosing a wider edge to stretch looks more natural, but affects more of the frame.

– **Expand:** (Only appears when Zoom Mode is set to Manual) Zooms the image.

– **Aspect:** (Only appears when Zoom Mode is set to Manual) Stretches the image.

(Left) The original 4:3 image edited into a 16:9 timeline with black pillar boxing to the left and right as a result. (Right) The image with Blanking Fill set to Warp Top Layer, stretching the left and right edges to fill the blanking area.

### Fill Appearance

These controls let you change the look of the image being used to fill the blanking area.

– **Blend Edges:** Lets you feather the edges where the original image meets the blanking fill area.

– **Blur Background:** Lets you choose how much or how little to blur the image that fills the blanking fill area.

– **Fade Amount:** Lets you fade or tint the blanking fill area. At 0, there’s no fade applied. At 1.000, the blanking area is filled with a solid color defined by the Fade Color control.

– **Fade Color:** A color picker/eyedropper combination that lets you choose a color with which to fade, tint, or fill the blanking fill area.

### Drop Shadow

These controls let you add a drop shadow to “lift” the foreground image against the blanking fill image.

– **Shadow Strength:** Lets you choose how solid the drop shadow appears.

– **Drop Angle:** Lets you choose the angle the drop shadow appears at. At 0 the drop shadow is centered.

– **Drop Distance:** Offsets the drop shadow farther in the direction of the Drop Angle

– **Blur:** Softens the drop shadow.

– **Color:** Tints the drop shadow.
Drop Shadow

Lets you add a simple drop shadow to any clip, using that clip's native or generated alpha channel to create the shape of the shadow.

– **Shadow Strength**: Lets you choose how solid the drop shadow appears.
– **Drop Angle**: Lets you choose the angle the drop shadow appears at. At 0 the drop shadow is centered.
– **Drop Distance**: Offsets the drop shadow farther in the direction of the Drop Angle.
– **Blur**: Softens the drop shadow.
– **Color**: Tints the drop shadow.

Edge Detect

An edge detection effect with options for customizing which edges create outlines.

– **Mode**: Lets you choose between RGB and Grayscale edges. RGB is the default.
– **Edge color**: (only enabled if Mode is set to Grayscale) Lets you colorize the edge outlines that are generated.
– **Threshold**: Determines the lightness level that’s used for edge creation.
– **Smooth**: Lets you soften these edges.
– **Brightness**: Lets you adjust edge intensity.
– **Denoise Type**: Can be switched between Soften and Sharpen, to preprocess the image.
– **Denoise Strength**: Raise this slider to emphasize dominant outlines and de-emphasize weak ones.
– **Edge Mask Overlay**: This checkbox lets you superimpose the edges created with this filter over the RGB image via a multiply operation.

Emboss

An emboss effect with several options to create different kinds of outline and emboss effects.

– **Emboss Style**: This pop-up lets you choose from among Relief, Emboss Over, Sobel, and Laplacian types of embossing.
– **Power**: Lets you adjust how pronounced the emboss effect is.
– **Angle**: Lets you choose the apparent angle at which the emboss effect is rendered.

Channels

Three checkboxes let you choose to use the Red, Green, and Blue channels to create this effect.
Mirrors

An effect that lets you reflect part of the image in any direction you like. At its simplest, this can create a split mirror effect like that found at the end of Prince’s “When Doves Cry.” At its most complicated, multiple reflections can be set up, to create whirling Kaleidoscope patterns in the image.

Main Controls

These controls let you choose what kind of effect this plug-in has.

- **Mirror Placement**: Lets you choose different types of mirror effects including Individual (a simple reflection), Rosette, and Kaleidoscope.

- **Reflect at Borders**: Lets you add another reflection of the image whenever the angle and position of your reflection would result in offscreen black coming into the frame.

Individual Controls

When Mirror Placement is set to Individual, a series of six sets of Mirror parameters lets you add multiple mirrored edges in different combinations; by default only one is on, but you can turn more edges on to create more complicated mirror effects. Each group of Mirror parameters has the following parameters:

- **Enable Mirror**: Turns that mirror reflection on.

- **X and Y Position**: Positions the center of the mirror split reflection.

- **Angle**: Lets you adjust the angle of the seam along which a reflection will run.

- **Flip**: Flips which side of the image is reflected.

Rosette Controls

When Mirror Placement is set to Rosette, a single set of parameters creates a variety of circular patterns.

- **X and Y Position**: Positions the center of the circular rosette reflection.

- **Angle**: Lets you adjust the orientation of the rosette pattern about its center.

- **Wedge Width**: Lets you adjust the thickness of the wedges around the outside of the rosette pattern, and by extension how many wedges there will be. Thicker wedges results in fewer reflections around the rosette pattern and thinner wedges result in more reflections around the rosette pattern.

Kaleidoscope Controls

When Mirror Placement is set to Kaleidoscope, a single set of parameters lets you create a variety of kaleidoscopic images:

- **X and Y Position**: Positions the center of the mirror split reflection.

- **Center Size**: Lets you shrink or expand the cells comprising the kaleidoscopic image.

- **Angle**: Lets you adjust the angle of the seam along which a reflection will run.

- **Number of Sides**: Three sides produce a triangular pattern, while four sides produce a rectilinear pattern aligned with the currently selected angle.
**Pencil Sketch in DaVinci (Studio Version Only)**

A plug-in with highly customizable controls for making an image look like it was drawn.

- **Sketch Stroke Controls**: Parameters to control the thickness of outlines, the threshold at which they appear around objects in the frame, and their length.

- **Sketch Tone Controls**: Parameters to control how many levels of tonality are in the rendered result, and contrast controls to influence how much of the image falls into shadows, mid-tones, and highlights.

- **Sketch Texture Controls**: Parameters to apply a customizable stippled texture over the image, with a checkbox to auto animate it.

![Original Image and Image with Pencil Sketch Applied](image)

(Left) The original image, (Right) The image with Pencil Sketch applied

**Prism Blur**

Simulates flat chromatic aberration and a vignetted lens.

- **Blur Strength**: Lets you blur the primary image.

- **X and Y Position**: Let you change the center of the effect within the frame about which chromatic aberration is created.

- **Aberration Distance**: Adjusts how far the aberration effect appears from the source image.

- **Aberration Strength**: Intensifies the zoom blur used to create the chromatic aberration effect to intensify it.

- **Vignette Size**: Lets you add edge vignetting to the image; setting this to 0 removes the vignette, while 1 is the maximum size of a vignette using this filter.

- **Vignette Sharpness**: Lets you adjust the feathering of the vignette effect; lowering this value softens the edge, while raising this value sharpens, but never fully eliminates the softness from this edge. The Vignette effect is designed to fall off in a way that simulates how a lens would exhibit vignetting.

**Scanlines**

Simulates television scanlines, or any effect where you want alternating lines to darken the image. A variety of parameters makes this an extremely flexible effect that can be applied in numerous ways.

**Appearance**

Let you customize the type of scanline effect you want.
– **Line Frequency:** Lets you choose how many or few lines are superimposed on the image; fewer lines automatically space themselves to be thicker as they’re uniformly distributed across the image.

– **Line Sharpness:** Lets you blur the border between each line, softening the effect.

– **Line Angle:** Lets you rotate the lines to appear at any angle; the default is 0 which results in horizontal lines.

– **Line Width:** Lets you increase or decrease the width of the blanking lines that obscure the image (which default to black but are tinted by the Color 2 parameter), thus increasing or decreasing the amount of image showing through.

– **Line Shift:** Lets you offset the lines being overlaid on the image. Animating Line Shift lets you create a rolling scanlines effect.

### Color

Lets you tint and shift channels of the alternating scanlines created by this filter. Exaggerated, this can create numerous other stylistic effects.

– **Color 1 and Color 2:** Color picker and eyedropper controls that let you tint each alternating set of lines (eyedroppers let you sample a color from the RGB image being input into the current node).

– **Shift Red, Green, and Blue:** Lets you offset individual channels.

– **Scanlines Only:** Lets you see just the scanlines in isolation while you adjust them.

### Composite

Lets you choose how to composite the scanlines effect against the original image.

– **Scanlines Only:** Lets you output an image consisting only of the scanlines pattern you’ve created. Good for creating different kinds of patterned textures and mattes.

– **Composite Type:** Lets you choose which composite mode is used to blend the scanline effect into the image.

### Stylize (Studio Version Only)

A plug-in that lets you apply one of a variety of painterly styles to an image based on analyses of different paintings, in such a way as to provide a temporally stable result for moving images as the style strokes will appear to be applied to individual objects in the scene that move and flow in a consistent way. There are two controls:

– **Styles:** A pop-up menu lets you choose an artistic style to apply to the image.

– **Style Scale:** This slider lets you adjust how large or small the applied art strokes should be applied.

(Left) The original image, (Right) The image with Style Transfer applied and set to Dance with a Style Scale of 4
**TIP:** This plug-in is more flexible than you think, if you apply Style Transfer in a layered way against the original image. You can do this using a duplicate layer in the Edit page, or using two nodes representing the Style Transfer effect and original image connected with a Merge node in the Fusion page or a Layer node in the Color page. Once that’s set up, simply combine the Style Transfer output with the original image using composite modes and opacity adjustments for more sophisticated blending. In particular, using the Luminosity composite mode lets you combine the texture from the Style Transfer while retaining the color of the original image, or using the Saturation composite mode lets you combine the color from the Style Transfer while retaining the texture of the original clip.

**Tilt-Shift Blur** *(Studio Version Only)*

Simulates depth-of-field effects using a progressive blur that’s applied with a generated Z-depth map. The default settings create a “miniaturization” illusion, where the image appears to be tiny due to the top and bottom depth-of-field settings used.

**Main Controls**

These controls select and control the overall effect.

- **Blur Type:** You can choose between Fast Blur and Lens Blur (Lens Blur is the default).
- **Blur Strength:** A slider lets you adjust the amount of blur you add.

**Lens Iris**

- **Iris Shape:** Lets you choose what type of apertures you want to use, with which to influence the shape of the bokeh effect. Aperture Shape options include Triangle, Square, Pentagon, Hexagon, Heptagon, or Octagon shaped aperture.
- **Blade Curvature:** (Only available with Real and Creative Apertures) Lets you round off the edges of the Aperture Shape you selected.
- **Rotation:** Lets you adjust the angle the shape appears at.
- **Anamorphism:** Lets you adjust the aspect ratio of this effect in order to match the lens blur created by anamorphic lenses.
- **Highlights:** Lets you adjust how the highlights of the image affect the blur, dilating or eroding the image more or less depending on how high Smooth Strength is.

**Depth of Field**

Additional Depth of Field settings let you adjust the depth map being used to create the depth-of-field effect.

- **Depth Map Preview:** This checkbox lets you see the greyscale depth map directly while making these adjustments. The white area will be blurred, while the black area will be unaffected.
- **Center X, Center Y, and Angle:** These parameters let you transform the depth map.
- **In Focus Range:** Lets you expand or contract the black center of the depth map that defines the blurred region.
- **Near Blur Range and Far Blur Range:** Two parameters let you individually adjust the falloff of the white bottom and top of the depth map.
**Vignette**

A plug-in with two modes for creating vignette effects of different kinds.
- Basic mode gives you Size, Anamorphism, and Softness controls for quickly creating a traditional lens vignetting effect to darken the edges of the frame. A Color control lets you tint the vignette.
- Advanced mode adds Border Shape, Rotation, Center, Transparency, and Composite Type controls for customizing this vignetting effect even more specifically.

**Watercolor (Studio Version Only)**

A variation on the Abstraction filter, this filter reduces images into simplified washes of softly blended colors, in a very painterly fashion.
- **Channels:** This pop-up menu lets you choose whether to use Luminance or RGB to derive the smoothed color from.
- **Show Gradient:** This checkbox lets you see the boundaries that define each area of smooth color, based on the value you choose from the Smoothness slider below.
- **Smoothness:** Adjusts the amount of detail in the final result. Low smoothness values result in more detail in the smoothed result, while higher values result in larger pools of lower detail yet smoother color.
DaVinci Resolve comes with several Resolve FX that focus on the application of an effect over time.

Contents

**Motion Trails** *(Studio Version Only)*
- General: 3087
- Advanced Options: 3087
- Move Trail: 3087

**Smear** *(Studio Version Only)*
- General: 3088
- Advanced Options: 3088
Motion Trails (Studio Version Only)

The Motion Trails effect copies the image to create ghost-like trails on moving images. This effect can be used to simulate clips shot with long shutter speeds and analog video feedback effects.

General

The first two sliders control the number and strength of the copied frames.

- **Trail Length**: Determines the number of copies that are used to create the trails.
- **Dropoff**: Sets the fade applied to each copied frame. The Dropoff value is compounded. For instance, using a value of .5 applies 50% opacity to the first copy, 25% to the second, 12.5% to the third, and so on.

Advanced Options

The advanced options are used to control how the overlapping copied frames are blended.

- **Composite Gamma**: The Composite Gamma menu provides four options for controlling the brightness of the overlapping frames.
  - **Timeline**: Uses the Timeline Color Space setting in the Project Settings to control the overlapping brightness. This setting, by default, is Rec. 709, Gamma 2.4.
  - **Rec. 709**: Uses a Rec. 709 color space with Gamma 2.2 to control the overlapping brightness.
  - **Linear**: Uses Linear Gamma, often producing much stronger highlights.
  - **Custom**: Provides a custom gamma slider which defaults to Gamma of 2.4. Setting this to a value of 1.0 is the same as setting the menu to Linear.

- **Input Alpha**: There are three choices in the Input Alpha menu that determine how the alpha channel is used for blending the frames. All three options assume there is an alpha channel present on the clip that has the Motion Trail applied.
  - **Ignore**: This is the default option and will cause the alpha channel to be ignored. Disabling the Use Alpha checkbox when Ignore is selected will cause the alpha to act as a stencil effect for the trails.
  - **Onto Current**: Uses the alpha channel for the trails, but instead of compositing it over the lower video track, the trails are composited over themselves using the current frame.
  - **Onto Black (Alpha Out)**: This option uses the alpha channel for the trails and compositing over the lower video track, assuming the Use Alpha checkbox is enabled.

Move Trail

This group of controls determines the offset, direction, size, and rotation of the copies. Adjustment amounts are applied as offsets from one copy to the next. For instance, if rotation is set to 5 degrees, the first trail copy is rotated 5 degrees, the second trail copy is rotated 10 degrees, the third copy is rotated 15 degrees, and so on.

- **Pan**: Adjusts the offset of the trail copies from the original image.
- **Pan Angle**: Changes the angle at which the trails are offset from the original image. The values are shown in degrees.
- **Zoom**: Adjust a scale adjustment, successively, to each copy.
- **Rotate**: Applies an angle of rotation, successively, to each copy.
- **Reuse Current Frame**: When this checkbox is disabled (the default), each copy uses the frame after the copy before it. For instance, the first copy is the current frame -1, and the second copy is...
the current frame -2. When this checkbox is enabled, all copies use the same frame as the current frame in the clip.

- **Border Type:** This menu determines how edges of the frame are handled when the copies are scaled smaller than the timeline resolution.
  - **Black:** The area outside the image is set to black.
  - **Soften:** This control blends the edges of the rectangular frame borders to give the images a more organic appearance.
  - **Replicate:** Duplicates the outermost pixels along the edge of the image. The pixels are stretched out from each side to reach the timeline resolution boundary.
  - **Reflect:** The image is flipped and flopped to create a mirrored image that extends to the timeline resolution frame boundary.
  - **Wrap-Around:** Duplicates the image to create a video wall effect, used to fill in the space to the timeline resolution frame boundary.

**Smear (Studio Version Only)**

The Smear effect simulates motion blur in a clip by blending a user-definable number of frames.

- **Frames Either Side:** Determines the number of frames that are blended on either side of the current frame. For instance, entering a value of 2 uses two frames before and two frames after the current frame to create the effect.

- **Luma Threshold:** This control sets how bright a pixel must be to contribute to the smear effect. A lower value causes only darker pixels to be smeared. A higher value includes brighter pixels in the effect.

- **Chroma Threshold:** This control sets how saturated a pixel must be to contribute to the smear effect. A lower value causes only low saturated pixels to be smeared. A higher value includes more saturated pixels in the effect.

**Stop Motion**

This plug-in is used to replicate the stuttering motion effect found in stop motion animations. Traditional stop motion animation exposes each frame of the shot individually, while the subject is manually moved in tiny increments between frames. An extremely labor intensive process, often individual frames were repeated in a shot to speed up the production which resulted in a staccato motion cadence.

**Advanced Options**

- **Set Reference Frame:** Selects the current frame in the Viewer as the reference frame.

- **Reference Frame:** The frame number of the reference frame used for the skip pattern. The frame number is calculated from the start of the entire original media clip (frame 0).

- **Sampling Variation:** This slider increasingly produces more uneven motion in the clip.

**General**

- **Frame Repeat:** Selects how many frames (from 1-10) to duplicate in the shot. A larger number makes a more staggered cadence.

- **Blend:** Lets you adjust the amount of blending of the clips original frame rate, with the repeating frames you’ve selected above. 0 is none, and 1.00 is the full frame rate of the clip.
Chapter 164

Resolve FX Texture

These plug-ins are designed to add texture to images, to replicate both naturalistic and other effects.

Contents

- **Analog Damage** (Studio Version Only) 3090
- **Detail Recovery** (Studio Version Only) 3090
- Detail Recovery 3091
- Details Extraction 3091
- **Film Damage** 3092
- Blur and Shift Controls 3092
- Add Vignetting 3092
- Add Dirt 3093
- Add Scratch 3093
- **Film Grain** (Studio Version Only) 3093
- Main Controls 3093
- Grain Params 3094
- Advanced Controls 3094
- **JPEG Damage** 3094
- **Texture Pop** (Studio Version Only) 3094
- Mode Controls 3096
- Details Controls 3096
- Tonal Range Controls 3096
Analog Damage (Studio Version Only)

A Texture category plug-in that simulates different kinds of signal degradation resulting from analog transmission and recording, Analog Damage can be used to create “old TV” or “junky videotape” effects of various kinds. A Preset pop-up menu lets you choose from a variety of different looks, while a Custom option lets you create your own.

It has the following categories of parameters:

- **Telecine Source**: Options for lens vignetting and automated shutter weave to the left and right.
- **Broadcast Signal**: Options for customizable noise, detail loss, signal ghosting, and chroma misalignment.
- **Color Dials**: Television-signal specific color adjustment controls.
- **Scan**: Controls to simulate problems with television scanning. H- and V-Shift let you “roll” the television signal, while V-Hold interacts with the V-Hold Latch parameter to make it easy to use simple key framing to trigger animated vertical rolls that “bounce” in a realistic way for broadcast. Overscan and vertical scale interact with Vertical Blanking to produce distortions that seamlessly loop to duplicated images at the top and bottom of the frame.
- **Scan lines**: Simulate customizable television scan lines that are capable of simulating moire and color artifacts.
- **TV Construction**: Controls to simulate issues with CRT phosphor brightness, tint, and defocus, and the ability to add a customizable curved border and warped screen curvature.
- **VHS**:Lets you add a customizable “Restless Foot” to simulate recorded tape artifacts.

**TIP**: Using the Analog Damage plug-in on the Fusion page makes it possible connect Modifiers to add automatic animation (such as Perturb) to different parameters in order to quickly and easily create automated video damage effects.

Detail Recovery (Studio Version Only)

Detail Recovery is a utilitarian effect that lets you extract image detail from the second input, in order to re-add it to the image coming in the first input. In this way, you can selectively add detail back to an image in which it’s been removed. Because of how it works, this is an effect that’s intended to be used on the Color page.
To use Detail Recovery, you must add it to the node tree as a Resolve FX node (dragging it directly from the Open FX library into the node tree as its own node), in order to expose both of the RGB inputs that appear on the node when you do this. By default, the first RGB input is for the image you want to add detail to, and the second RGB input is for the image you’re extracting image detail from.

In the following example, Node 1 is the base grade, and Node 2 is a grade in which the highlights are being blown out for stylistic effect. The Detail Recovery node is then being added to add specific image detail from Node 1 back to the output of Node 2.

Setting up the Detail Recovery effect to add image detail from Node 1 to the image coming from Node 2

The result, compared with the image in Node 2, is an image that’s still harshly exposed, but that has traces of fine image detail so it doesn’t look so clipped.

Detail Recovery has the following parameters.

**Detail Recovery**

- **Transfer Direction**: This drop-down menu lets you choose which input provides the detail and which input the detail is combined with.

**Details Extraction**

- **Frequency Cutoff**: A slider that lets you choose how much detail you want to extract for recovery. Lower values isolate finer details; higher values include progressively larger details.
- **Strength**: This slider lets you exaggerate or attenuate the detail that’s extracted for recovery.
– **Detail Mix**: At a value of 1.000, this slider blends the extracted detail with the image you’re adding it to so that both layers blend together. At a value of 0.000, the extracted detail replaces whatever overlapping pixels are in the image you’re adding it to. Using this slider, you can choose the best blend for your purposes.

– **Preview Detail checkbox**: Turning this checkbox on lets you see the detail that’s being extracted using the Frequency Cutoff and Strength sliders.

**Film Damage**

Found in the ResolveFX Texture category. After you’ve used the new ResolveFX Revival plug-ins to fix damage in archival footage, you can turn around and use the Film Damage plug-in to make brand new digital clips look worn, dirty, and scratched instead. When used in conjunction with the Film Grain and Flicker Addition plug-ins, you can convincingly recreate the feel of poorly kept vintage archival footage.

![Original image vs. Result with Film Damage](image)

**Blur and Shift Controls**

The three parameters at the top let you alter the foundation of the image to begin creating the look of an older film.

– **Film Blur**: Adds just a bit of targeted defocusing to knock the digital sharpness out of the image.

– **Temp Shift**: Defaults to warming the image just a bit to simulate the warmer bulb of a film projector, although you can use it to cool or warm the image in varying amounts.

– **Tint Shift**: Defaults to yellowing the image to simulate damage to the film dyes, but you could move the slider in the other direction to add a bit of magenta, simulating a different kind of dye failure.

**Add Vignetting**

These parameters simulate lens vignetting darkening the edges of the image.

– **Focal Factor**: Adjusts how far the vignetting extends into the image.

– **Geometry Factor**: Affects how dark the vignetting is and how pronounced the edges are.

– **Tilt Amount**: Affects how balanced the vignetting at the top of the image is versus the bottom of the image.

– **Tilt Angle**: Affects how balanced the vignetting left of the image is versus the right, but only when Tilt Amount is set to something other than 0.
Add Dirt
These parameters let you simulate dirt particles (not dust) that have adhered to the film. These are larger specks, although there’s several ways you can customize these.

- **Dirt Color**: This control lets you choose what color you want the dirt particles to be (black simulates dirt on a print, while white simulates dirt on a negative).
- **Changing Dirt**: This checkbox lets you alternate between simulating temporally unstable dirt on the film (checkbox on) and dirt on the lens that doesn’t move (checkbox off).
- **Dirt Density**: Lets you choose more or less dirt particles appearing over time. Dirt Size lets you choose the average size of dirt particles to appear.
- **Dirt Blur**: Lets you defocus the dirt, so it’s not so sharp.
- **Dirt Seed**: Changes the random distribution of dirt when you change this value, but for any given value, the results for any given set of control adjustments remain consistent.

Add Scratch
Five sets of Add Scratch parameters let you add up to five scratches to the image, simulating something scratching the emulsion while the film played.

- **Scratch Color**: Lets you choose the color you want the scratch to be (scratches can be a variety of colors depending on the depth of the scratch, type of film, and method of printing).
- **Scratch Position**: Lets you adjust the scratch’s horizontal position on the image.
- **Scratch Width and Scratch Strength**: Let you adjust the scratch’s severity.
- **Scratch Blur**: Lets you defocus the scratch.
- **Moving Scratch**: This checkbox lets you choose whether the scratch is jittering around or not.
- **Moving amplitude**: Determines how far it moves. Moving Speed determines how fast it moves.
- **Moving Randomness**: Determines how it meanders about.
- **Flickering Speed**: Determines how much the scratch flickers lighter and darker in severity.

Film Grain *(Studio Version Only)*
Composites a procedurally generated layer of simulated “film grain” over the image. Individual simulated grains with falloff are generated to match the resolution of the project.

Main Controls
These controls let you quickly choose and apply a film grain effect.

- **Film Grain Presets**: This pop-up lets you quickly choose from among different 8mm, 16mm, and 35mm film grain effects.
- **Composite Type**: Lets you choose a composite mode with which to combine the image with the grain simulated by this plug-in.
- **Opacity**: Lets you fade the Film Grain effect against the original image.
- **Grain Only**: This checkbox lets you see just the grain layer that you’re creating, so you can evaluate its look prior to it being composited into the image.
**Grain Params**

The Grain Params group lets you adjust the quality of the grain.

- **Texture**: Larger values create more separation between the grains generated by this plug-in, while smaller values bunch them up closer together to create denser grain patterns.

- **Grain Size**: Larger values zoom into the individual simulated grains generated by this plug-in, while smaller values zoom out.

- **Grain Strength**: Adjusts the contrast of the simulated grain layer. Higher values produce more contrast, lower values less.

- **Offset**: Lightens or darkens the entire simulated grain layer. The practical effect is that lower values emphasize lighter grains, while higher values emphasize darker grains.

- **Symmetry**: An asymmetrical contrast adjustment. Lower values darken the lighter grains, while higher values brighten the darker grains.

- **Softness**: Lets you blur the grain layer to create even softer transitions from one grain to another.

- **Saturation**: Lets you make the grain more or less colorful. At a value of 0, grain is monochrome.

**Advanced Controls**

In the Advanced Controls, the Shadow, Midtone, and Highlight Gain controls let you adjust the amount of grain that’s composited into each of these tonal regions of the image. When the Optimized Mode checkbox is turned on (the default), performance should improve substantially.

**JPEG Damage**

Simulates the kinds of minor or major artifacts you get when doing JPEG compression; useful for simulating compression damage.

- **Quality**: Lets you lower the bit depth of the image.

- **Resolution**: Lets you increase the size of macroblocking artifacts that appear.

- **Block Aspect Ratio**: Lets you adjust the macroblocks to be more square or rectangular.

- **Frequency Scale**: Sharpens the effect.

- **Scale Component**: Lets you base this effect on All Frequencies, the X-Frequency, or the Y-Frequency.

**Texture Pop (Studio Version Only)**

Texture Pop is a more sophisticated and flexible version of the Midtone Detail control found in the Primaries and HDR palette. Using the controls of this effect, you can either remove texture or exaggerate it. There are two modes of operation that determine how specific a result you can achieve.

- In Simple mode, you can apply more extreme versions of the Midtone Detail effect found in the Primaries and HDR palette. A single Details slider lets you soften or sharpen midtone detail in the image with a greater range of operation, while a Strength slider lets you exaggerate the effect further or attenuate the effect to back it off.
In Advanced mode, you can fine-tune the softness or sharpness of high, medium, and low-frequency image detail with great specificity via seven individual “details” sliders, labeled Rough, Coarse, Medium, Small, Fine, and Tiny. This lets you adjust the textural characteristics of multiple frequencies of image detail in different ways, for example softening Fine detail while intensifying Medium detail. The Strength slider lets you exaggerate or attenuate the overall effect caused by all sliders.

In either mode, the Details/Range sliders default to 0.000, which causes no change to the image. This is the level to choose to preserve the original quality of detail in the image. They range from -1.000 (maximum softening) to +1.000 (maximum sharpening). Additionally, a set of Tonal Range controls (described later) lets you choose how much of this effect is applied to the Shadows, Midtones, and Highlights of the image, giving you even more specific control over which parts of the image are softened and/or sharpened.

Understanding Advanced Mode

Advanced mode is the most exciting way to use this effect. The best way to learn what Advanced mode does is to set all of the Details sliders to -1.000, and then raise each one individually to see what kind of image detail get reintroduced, and ultimately enhanced, if you raise each slider above 0.000. In the following image, each of the Details sliders has been set to -1, which is the maximum smoothing for each setting. The result is an image with minimal detail.

In the following example, a person and the mechanical details of a helicopter shot are smoothed by setting each detail slider to -1.000. You can see that the resulting images both retain the broad strokes of color and contrast that define each region of color, but outside of high-contrast edges, all textural detail has been smoothed to a clean gradient.

![An image of a person with all detail smoothed](Left) ![An image of mechanical detail with all detail smoothed](Right)

Then, by raising each of the Details sliders back to 0 or even +1 one at a time, you can see exactly what kind of detail that slider is affecting. As you can see in the example of the person, the Tiny and Fine sliders are affecting only the smallest details, hairs, lines, and pores of the skin. In the helicopter detail, you can see the kind of small textures, tiny lines, and rivet details that come back.

![The same image of the person with the Tiny and Fine sliders raised to add subtle detail back to the image](Left) ![The helicopter detail with Tiny and Fine detail added back to the image](Right)
Here are two sets of generalizations that hold true if you’re thinking about the detail of a human face.

- Tiny, Fine, and Small controls affect the smallest details in an image, including the pores (tiny), blemishes (fine), and wrinkles (small) of average closeup shots. Other features affected would include high-frequency edge detail of strands of hair, leaves on a tree, or text on a page of paper or screen.
- Rough, Coarse, and Medium tend to affect progressively smaller shadow contouring of faces, bodies, and objects.

Of course, the granularity of a particular type of image detail depends on how much of a closeup or long shot the clip is. When the camera is closer to the subject being adjusted, you’ll be able to adjust much finer details. When the camera is distant, then even large details on the subject are affected by the Tiny, Fine, and Small controls. This means when you create an adjustment for a subject in a closeup, you’ll need to make changes to the adjustment if you try and apply it to a long shot.

**Mode Controls**

- **Operating Mode:** Lets you choose between the Simple and Advanced modes of this plug-in.
- **Color Mode:** Lets you choose between working in RGB and Luma/Chroma mode. In RGB, a single set of parameters affect all three color channels at once. In Luma/Chroma mode, two sets of controls let you fine-tune the luma and the chroma separately.
- **Output Mode:** Lets you choose between outputting the Final Result, Differences mode, which lets you see the effect differed against the original image, and Difference Magnitude, which shows a high-contrast differencing comparison.

**Details Controls**

- **Strength:** Lets you exaggerate the effect of the other Details sliders further, or attenuate the effect to back it off.
- **Details:** (Simple mode only) Lets you soften or sharpen midtone detail in the image with a greater range of operation.
- **Rough/Coarse/Medium:** (Advanced mode only) These three sliders affect progressively larger contours of the image, appearing to affect the shadows and structure of the image.
- **Small/Fine/Tiny:** (Advanced mode only) These three sliders affect progressively smaller details and texture of the image, adjusting medium to tiny details, lines, and specks.

**Tonal Range Controls**

- **Shadows:** Lets you reduce the effect you’ve created in the shadows of the image, as defined by the Low Range parameter.
- **Midtones:** Lets you reduce the effect you’ve created in the midtones of the image, as defined by the Low and High Range parameters.
- **Highlights:** Lets you reduce the effect you’ve created in the highlights of the image, as defined by the High Range parameter.
- **Low Range:** Lets you define the image value that defines the transition from Shadows to Midtones.
- **High Range:** Lets you define the image value that defines the transition from Midtones to Highlights.
Chapter 165

Resolve FX Transform

The plug-ins in this category allow different types of animated and non-animated transforms than are possible in the Sizing palette or Clip Transform controls of the Inspector.

Contents

**Camera Shake** (Studio Version Only) 3098
Main Controls 3098
Shake Levels 3098
Shake Quality 3098
Blanking Handling 3099

**Match Move** (Studio Version Only) 3099
A Match Move Workflow 3100
Main Controls 3104
Tracking Controls 3104
Positioning 3105
Compositing 3105
Stabilizing 3106

**Transform** 3106
General 3106
Control Options 3107
Advanced Options 3108
Global Blend 3108

**Video Collage** 3108
Create Background 3109
Create Tile 3110
Animating Tiles and Advanced Layouts 3113
Video Collage Controls 3115
Layout 3115
Margins and Spacing 3115
Synchronize Keyframing 3116
**Camera Shake** *(Studio Version Only)*

This effect replicates random camera motion for Horizontal and Vertical position, Rotation, and Zoom. A variety of parameters are provided to let you customize the quality of motion, from slow meandering drift to abrupt, jagged jerks and pops.

**Main Controls**

The primary controls governing how much camera shake is added.

- **Motion Scale and Speed Scale**: These sliders let you adjust the overall amplitude and speed of camera shake that’s introduced to the image.
- **Motion Blur**: Lets you add simulated motion blur to the image being shaken, which can add a more realistic look to the motion. Motion blur is more visible on fast-moving motion, as DaVinci Resolve is simulating the effect of a motion picture camera’s shutter speed on exposed subjects in motion.

**Shake Levels**

These controls let you adjust the intensity of camera shake.

- **Pan Amplitude**: Lets you set how much horizontal motion you want.
- **Tilt Amplitude**: This slider lets you choose how much vertical motion you want. These sliders are completely independent of one another.
- **Rotation Amplitude**: Lets you introduce rotational motion to the camera shake, as well.
- **PTR Speed**: This slider lets you choose how fast the Pan, Tilt, and Rotation camera shake is.
- **Zoom Amplitude**: This slider lets you add zooming to the camera motion being created.
- **Zoom Speed**: This slider lets you choose how fast this random zooming should occur.
- **Zoom Type**: This pop-up menu lets you choose how to add zooming; you can choose Outward Only, Inward Only, or Outward and Inward. If you choose Inward Only, you don’t have to worry about blanking appearing around the edges of the frame.

**Shake Quality**

These controls let you customize the type of shaking you want.

- **Motion Method**: This pop-up menu lets you choose from different ways of generating the motion this plug-in introduces. You can choose from SINE, Rectified SINE, Rectified SINE (inverted), and Square Wave (good for popping or flickering motion).
– **Phase:** This slider lets you set the starting point of the camera shake you’re creating, based on the Motion Method and Amplitude settings you’ve chosen.

– **Randomness Scale:** This slider lets you introduce irregularity to the Horizontal, Vertical, and Rotational motion of the camera shake. The greater this value, the more irregularity will be introduced.

– **Randomness Speed:** This slider lets you choose between smoothly erratic motion (at lower values) or more jagged motion (at higher values).

– **Pause Length:** This slider lets you adjust the frequency of intermittent pauses that break up the random motion added by this filter.

– **Pause Interval:** This slider lets you adjust the duration of intermittent pauses that break up the random motion added by this filter.

– **Pause Randomness:** This lets you add a degree of randomness to the intervals that happen.

– **Random Seed:** This slider lets you alter the value that sets what random values are being produced. Identical values result in identical randomness.

### Blanking Handling

These controls let you determine what to do when camera shake causes blanking past the edge of the image.

– **Border Type:** This pop-up menu lets you choose how you want to fill the empty spaces at the edge that appear if the camera shake you create pushes the image out of the current frame size of your project. Four options let you choose to Replicate, Reflect, or Wrap-Around the image to fill the gap.

– **Zoom to Crop:** This slider lets you zoom in on the image to crop out unwanted blanking being introduced by the Camera Shake effect.

### Match Move (Studio Version Only)

**TIP:** Match move workflows are now much more effectively accomplished in the Fusion page using the tools and methods found there.

The Match Move filter is a patch-based tracker that follows a pattern region defined by a tracker control. You can place as many trackers as you like by applying this filter to a node and clicking on a feature you want to track in the Viewer. Ideal features for tracking are high contrast details that have sharp angles that are clearly defined.

Each tracker control consists of (a) a center point that indicates where the tracked motion path will be centered, (b) an inner box that identifies the patch of image you’re tracking (that can be resized), (c) an outer box that defines the search region for the track (that can also be resized), and (d) a patch window that shows you a zoomed in closeup of the patch you’re tracking. Patch windows can be resized, and the other tracking controls hidden or shown, using controls in the Display Options section of the Match Move controls.
If you’ve accidentally placed a tracker control somewhere you don’t want one, you can either drag anywhere within the inner box to move it to another location, or you can Option-click it to delete that tracker.

Once placed, you can choose how much image detail is considered for analysis by resizing that tracker control. To resize a tracker, move the pointer over the edge of the inner box, and drag to shrink or enlarge it.

This plug-in will automatically derive as much motion data as the number of trackers you’ve placed allows:

- One tracker tracks horizontal and vertical position (pan and tilt).
- Two or more trackers also track rotation.
- Four or more trackers also track perspective.
- If you place six or more trackers, then the Match Move filter is capable of automatically choosing the best tracker data from the overall collection to give you the most accurate track that’s possible.

A Match Move Workflow

The following example shows the simplest complete workflow for importing a foreground clip to composite with a match move to follow a background clip that’s already in the timeline. This workflow is suitable for such operations as placing a graphic as a sign on a side of a building, or into the display of a phone.

To match move:

1. Open the Media Pool in the Edit page, right-click a clip you want to match move to a clip in the Timeline, and choose “Add as Matte For Color Page Clip” to add it to the Color page Node Editor of the currently selected clip as a Timeline Matte. This is currently the only way you can match move and composite a foreground clip against a background clip in the Color page.

2. Open the Color page, make sure the background clip you want to match move to is selected, then open the OpenFX library and drag the Match Move plug-in directly onto the connection from the last node in the tree to the Output, to add it as a stand-alone FX node.
3 Right-click any corrector node in the node tree (Node 01 in this example) and choose the clip you added in step 1 in the Add Matte > Timeline Mattes submenu of the contextual menu to expose that clip as an Ext. Matte node. Delete the connection between the new Ext. Matte node and the node it’s connected to, and then reconnect its RGB output to the second input of the FX node.

4 Select the FX node, make sure the OpenFX onscreen controls are enabled, choose whether you want to start at the first or last frames of the clip to begin the tracking process, and then click within the Viewer to place tracker controls on the surface of the image you’re going to attach the foreground image to. If you want to do a perspective track, place at least four tracker patches in areas you know won’t be occluded by other things in the frame. Choose features that are high contrast and angular for the best results, and try to make sure the features you track won’t go offscreen or be occluded by other features within the frame. As you place tracking controls, their patch window will be tinted the color of the channel that DaVinci Resolve automatically determines will provide the best tracking result.

5 (Optional) If necessary, you can delete trackers you don’t want by Option-clicking them.

6 Now that your tracker controls are all set up, you’re ready to begin the tracking analysis. If the playhead is at the beginning of the clip, click Track Forward, otherwise click Track Backward. DaVinci Resolve will automatically analyze all tracker controls within the clip until the last frame of the clip is reached.
Using the Tracking controls

7 (Optional) If anything occludes a patch that’s being tracked, or if the tracked feature starts going off the edge of the frame, that tracker control may veer off course and will eventually turn off. If this happens, there’s a way to continue the track that’s surprisingly easy:

a. Click the Track Forward or Track Backward button again to stop the analysis.

b. Move the playhead back to the last good frame of tracking data, then click the inner box of each tracker control that went wrong to make sure they’re turned on (you know it’s on if the patch window is displayed), and then click “Clear tracking forward” or “Clear tracking backward” as necessary to delete the incorrect tracking data. When you’re done, click the inner box of each tracker that went wrong to turn it back on again, so it doesn’t continue trying to track incorrectly (you know it’s off if the patch window is hidden).

c. Now, place additional trackers on different features of the same surface to replace the trackers that you had to turn off.

d. Click “Track forward” again to continue the track, and DaVinci Resolve will automatically use those additional features to continue the analysis.

e. When the analysis is complete, turn the trackers you disabled back on again. All trackers that are turned on contribute data to the match move, for whichever ranges of frames they contain valid tracking data.

8 When DaVinci Resolve finishes its analysis, move the playhead back to the first frame of the track, and choose Positioning from the “Show controls for” pop-up menu. This takes you to the next stage in the Match Moving process.
Choosing the Positioning controls

9 A grid appears, covering the Viewer. This is the positioning canvas, and it lets you corner-pin the area in which the foreground image you connected in step 3 will be composited and tracked. You can corner-pin and resize it by dragging it by the corners, and you can move it by dragging the center.

Resizing the canvas to fit the foreground image into the background

10 Once you’ve positioned the grid, scrub back and forth to verify that it tracks correctly and looks right once it’s in motion.

11 Choose Compositing from the “Show controls for” pop-up menu to expose the compositing controls.

12 Set the Output pop-up menu to “Composite” to output the final match Moved composite. If necessary, you can use the Composite Type and Plate Cropping controls to choose how the foreground image is blended with the background and whether you need to crop unwanted parts of the image from the edges.

The final match moved composite

At this point, you’ve finished the match move.
**Main Controls**

The “Show controls for” pop-up menu lets you choose one of four pages of controls that take you through the match moving workflow. The Output pop-up menu lets you choose what you want to output, with choices for Disabled, Positioning Reference, and Composite.

**Tracking Controls**

The Tracking Controls govern the first stage of the match moving process, and this page of controls provides everything you need for setting up, executing, and refining multi-patch motion tracks.

The controls that are exposed when Main Controls is set to Tracking Controls

![Tracking Controls](image)

**The Tracking Controls group**

The primary controls used to initiate tracking. These consist of the tracking buttons that let you execute tracks either automatically using the outer Track Forward or Track Backward buttons, or manually using the inner Track Next or Track Previous buttons. The middle button lets you pause tracking.

The Next Track End and Previous Track End let you jump to previous and subsequent tracked sections of frames; in cases where there may be gaps in your tracking data, these controls let you jump to different segments of contiguous tracking data.

Two checkboxes let you choose whether you want to track and analyze Zoom and/or Rotation. These must be set before you begin tracking.

**The Manage Tracking Patches group**

The two buttons at the top let you choose which tracking patches are enabled to contribute to the overall match moving result, or disabled. Activate None and Deactivate All let you turn all patches on or off at once.

Clear Past and Clear Future let you clear bad tracking data forward or back in time from the playhead’s current position, for enabled tracker controls. Delete Tracking lets you delete the tracking data at the current frame only for enabled tracker controls.

Refresh Tracks updates a tracker control’s patch when the feature it’s tracking changes shape, color, or lighting enough to interrupt the track. Select one or more trackers and click Place New Patch in Track to update the tracked feature at that frame.
The Display Options group
This group lets you turn the visibility of different onscreen controls off and on. Checkboxes let you Show Trackers, Show Center (the red tracking center point), Show Paths (the tracked motion paths), and Show Active Patches. A slider lets you adjust the size of each patch window.
Show Comp Result lets you see the composited foreground layer against the background layer.

Positioning
The Positioning controls govern the second stage of the match moving process. They provide everything you need to transform the foreground image to fit against the background by moving, corner-pinning, and resizing.

Canvas Options
The Canvas Controls pop-up menu lets you switch between corner-pin controls, where dragging the four corners lets you corner-pin, dragging the center lets you reposition, and dragging the top, bottom, and sides lets you resize vertically or horizontally.

A Reset Corners button lets you reset the grid to full screen, if you need to scrap what you’re doing and try again.

The Display Options group
This group lets you turn the visibility of different onscreen controls off and on. Checkboxes let you Show Trackers, Show Center (the red tracking center point), and Show Paths (the tracked motion paths).
Show Comp Result lets you see the composited foreground layer against the background layer.

Compositing
The Compositing controls govern the third stage of the match moving process, to use when fitting the foreground image against the background image to make a seamless composite. Note, if you need to color correct the foreground image to match the background, you’ll need to add a corrector node between the Ext. Matte that’s routing in the foreground image into the Color page and the FX node that’s doing the compositing.
The controls that are exposed when Main Controls is set to Compositing

**Rendering Options**

The Composite Type pop-up menu lets you choose whether the composite that’s being output is an overlay of the Ext. Matte over the background, or the background Plate only.

**Plate Cropping**

Four sliders let you crop the Left, Right, Top, and Bottom of the image, if necessary.

**Global Blend**

The Blend slider, present in every ResolveFX plug-in in DaVinci Resolve, lets you adjust the opacity of the effect, effectively controlling the opacity of the foreground layer.

---

**Stabilizing**

The Stabilizing controls actually have nothing to do with match moving, but instead allow you to use the motion tracking accomplished with the Tracking Controls to stabilize the image. An Edge Behavior pop-up menu lets you choose how to handle blanking around the edges as a result of the background image being transformed to keep the subject of the frame in place.

---

**Transform**

The Transform Resolve FX adds considerable control over the standard transforms in the Inspector’s Sizing or the Color page Sizing palette. This effect includes all the standard Position, Tilt, Zoom, and Rotate controls but adds corner pinning, two kinds of on-screen controls, motion blur, and Edge behavior controls.

**General**

- **Control Mode:** This drop-down menu includes three methods for controlling the transforms. One is based on sliders in the Inspector, while the other two are based on manipulating the Viewer’s image.

- **Sliders:** Uses sliders and checkboxes in the Inspector to control the transforms. This method has no Viewer overlays with which to control the position, scale, or rotation but provides exact control using numeric values.
Interactive-Canvas: Choosing this mode moves the controls from the Inspector to the Timeline Viewer. The Viewer’s controls are shown as a bold white outline and four vertices, one at each corner. You can drag on any part of the white outline for stretching, squeezing, and corning pinning. Dragging the center of the image repositions the frame. The red subdivision overlays make it easy to create shearing effects by dragging line segments to move two corners simultaneously.

Interactive-Pins: Adjusting the image in this mode is done by manually placing control points, called pins, in the Timeline Viewer. Adding one pin only gives you position control. At least two points are required for scaling and rotation. Dragging on one of the pins scales or rotates the image around the other pin. Using three pins, you can create perspective distortions by dragging any one of the pins. You can add up to four pins for unique corner pinning distortions.

**TIP:** You can Option-Click on a pin to remove it or use the Reset Canvas button to remove all the pins.

Only one Control mode can be active at a time. For instance, you cannot make adjustments with the sliders and then switch to one of the interactive methods. The sliders will be reset once a different method is selected. However, can you apply two Transform effects to a clip, adjusting one with Sliders and the other using an interactive method.

Control Options

- **Canvas Keyframe:** Only displayed when the Control mode is set to Interactive-Canvas or Interactive-Pins. The Canvas Keyframe has no control except for a keyframe button allowing you to keyframe the changes you make in the Viewer.
- **Reset Canvas:** Resets any interactive changes made in the Viewer and any keyframes created from those changes.

The following parameters are only displayed when the Control Mode is set to Sliders.

- **Position X and Y:** Moves the image within the frame, allowing pan and scan adjustments to be made. X moves the image left or right, and Y moves the image up or down.
- **Zoom:** Allows you to blow the image up or shrink it down.
- **Rotate:** Rotates the image around the center.
- **Flip Horizontal/Vertical:** Two checkboxes let you flip the image in different dimensions.
  - **Flip Horizontal:** Reverses the image along the X-axis, left to right.
  - **Flip Vertical:** Reverses the clip along the Y-axis, turning it upside down.
– **Width:** Stretches or squeezes the image in one direction only.

– **Height:** Stretches or squeezes the image in one direction only.

– **Pitch:** Rotates the image toward or away from the camera along an axis running through the center of the image, from left to right. Positive values push the top of the image away and bring the bottom of the image forward. Negative values bring the top of the image forward and push the bottom of the image away. Higher values stretch the image more extremely.

– **Yaw:** Rotates the image toward or away from the camera along an axis running through the center of the image from top to bottom. Positive values bring the left of the image forward and push the right of the image away. Negative values push the left of the image away and bring the right of the image forward. Higher values stretch the image more extremely.

### Advanced Options

– **Edge Behavior:** This menu determines how edges of the frame are handled when the transforms are scaled smaller than the Timeline Resolution.

  – **Black:** The area outside the transformed image is set to black.

  – **Reflect:** The image is flipped and flopped to create a mirrored image, which extends to the Timeline Resolution frame boundary.

  – **Wrap-Around:** Duplicates the image to create a video wall effect, which is used to fill in the space to the Timeline Resolution frame boundary.

  – **Replicate:** Duplicates the outermost pixels along the edge of the image. The pixels are stretched out from each side to reach the Timeline Resolution boundary.

– **Motion Blur:** Keyframing the transform so the frame moves rapidly will create a blurring effect. The amount of the blur is controlled using the Motion Blur slider.

### Global Blend

– **Blend:** Lets you dissolve between the image with no Transform applied and one with the Transform fully applied.

### Video Collage

Video Collage is designed to make it easier to create grid-based layouts of multiple video layers to create different kinds of split-screen effects, where each video layer appears within a “tile” that can be styled in different ways. Layout controls let you choose how many rows and columns there are, which determine how many tiles are available to arrange tiles of video next to one another in different ways, with additional controls for creating offsets, changing the margins around and spacing between the tiles, and rounding the corners of each tile.

This effect is designed to be used in the Cut and Edit pages, and there are two ways that you can set this up, which are chosen using the Workflow drop-down menu.
Create Background

The Create Background option is perhaps the simplest way to create a split-screen using this effect. This mode creates a frame with holes in it, behind which you can position multiple layers of video. These clips are placed on tracks underneath the background clip in the Timeline, and use each clip’s individual sizing controls in the Inspector (which can be used via on-screen Transform controls in the Viewer) to scale and position them correctly within the holes. The Video Collage effect is applied to the topmost superimposed video or still image clip in the Timeline, in order to use that clip as a background for the frame.

In the following example, the Video Collage effect is applied to the clip on track 5, which has four other clips underneath it in a stack, each of which has been positioned to fit in one of the holes of the frame.

Create Background mode makes it easy to create a split-screen layout of different clips without having to resize them with precision to align the edges and sizes of each clip. The width of the frame that’s created gives some wiggle-room to reposition and animate each individual clip within the hole it shows through. You can see the resulting effect created in the previous example below.

The resulting split-screen effect, with four clips arranged to show through the holes created in the top “background” clip that’s creating the frame; you can see the onscreen controls corresponding to the clip on track 4 that have been used to position and resize it to fit.
Create Tile

This mode of operation is a bit more work to set up, as it requires you to create a layout in one instance of this effect, but it gives you more options, automatically transforming each layer of video in your stack of clips in the Timeline to fit a layout you design. The best way to work in Create Tile mode is to edit a stack of superimposed clips in the Timeline, but this time if there’s a clip you want to use as the background, it should go at the bottom of the stack.

Then, apply the Video Collage clip to the topmost clip, and set the Workflow drop-down menu to Create Tile. Immediately, you’ll see that the current layer has been fit inside the first rounded tile of the default layout of four tiles. For clarity, video tracks 4, 3, and 2 have been muted so you can see the current clip turned into a tile against the bottom clip that serves as the background for this arrangement.

Ultimately, you’ll use Paste Attributes to apply a copy of this effect to each clip on the Timeline that’s supposed to fit inside a tile, and once you choose which clip goes inside each tile, that’s what will create the arrangement. Before you do that, however, you need to customize the layout.

To get a preview of the entire layout for further customization, turn on the Preview Layout checkbox in the Inspector. This draws a preview of how all the tiles will be placed using the current layout. Using this preview, you can make whatever changes you want to set things up, before you copy this plug-in to all the other clips in the stack.
Turning on Preview Layout to customize the layout

With Preview Layout enabled, you can use the Layout controls below to choose how many columns and rows of tiles there are, to stagger the tiles horizontally or vertically, to round or square off each tile by a variable amount, and to alter the margins and spacing. In this way, you can create a wide variety of different symmetrical layouts really easily. In this example, we’ll create a layout with one row, three columns, that’s staggered vertically.

Now that this is done, we’ll turn off Preview Layout to focus on the current clip’s integration into our layout, and we can see that it doesn’t quite fit into the box. Click the Tiles button in the Inspector. This reveals the Tile-specific controls, which include the Resize Content controls. Click the disclosure control to open these up, and use the Pan, Tilt, and Zoom controls to make this image fit into the tile full screen.
You should also note the Active Tile drop-down menu. This menu serves two purposes. First, it defines which tile the current clip is displayed within. This becomes important later on when you apply this effect to multiple superimposed clips. However, it also determines which tile you further customize using the Tile-based controls of the Inspector. If needed, tiles can be individually styled.

The Manual Tile Management checkbox is off by default, which enables DaVinci Resolve to automatically update the number of tile entries in the Active Tile drop-down menu with items equal to the number of grid positions (or grid nodes) defined by the rows and columns you’ve set, without you needing to do anything. For simple symmetrical layouts, this is easiest. However, if you turn Manual Tile Management on, you gain the ability to add and delete tile positions manually, which enables other options. For now, we’ll leave this turned off.

So, now we’ve created a custom overall layout, and we’ve tailored the top clip in the stack to fit the first tile in the layout. Now it’s time to apply this effect to the next two clips in the stack (remember the bottom clip will be used as a background, so it doesn’t need this plug-in applied to it). Select the top clip with the effect applied to it in the Timeline, and press Command-C to copy it. Then, select the next two clips, right-click one of them, and choose Paste Attributes (Option-V). When the Paste Attributes window appears, turn on the Plugins checkbox, in Video Attributes and click Apply. Those two clips disappear as they receive the Video Montage effect and fit themselves into Tile 1, just like the top clip.

To assign each clip to the correct tile in the layout, select each clip in the arrangement, one at a time, open the Effects panel of the Inspector, click the Tiles button in the Inspector (if necessary), and set each clip to be the next available tile in the Active Tile drop-down menu. In this example, the top clip was in Tile 1, the second clip down will be in Tile 2, and the third clip down will be in Tile 3.
Assigning the Active Tile for each layer in the Timeline

**TIP:** If you enable the Open FX Overlay of the Timeline Viewer, each tile has an overlay that lets you click a tile in the Viewer to make that the Active Tile.

If you like, you can rearrange which clips go into which tiles using this control, but for now we’ll keep things simple. As you do this, each tile becomes populated, and the final layout is revealed, with the background clip showing behind everything. If necessary, you can use the Resize Content controls (in Tiles mode) to resize each tile’s contents to fit the tile better.

The current layout, with each clip in the stack assigned to a different tile

**NOTE:** If you’ve customized a layout, copied and pasted attributes to the other clips you want to use in that layout, and have assigned each clip to its position in the layout, and you then decide you need to make a change to the Globals layout controls, you’ll need to go through the process of copying the updated effect, pasting attributes to the other clips, and reassigning each clip to the appropriate position in the layout to make that update to the other clips as well.

So, these are the overall workflows of the Video Collage effect. There is, of course, much more you can do, but this is the basis of how you create your initial layout.

**Animating Tiles and Advanced Layouts**

One of the more powerful aspects of the Video Collage effect is the ability to quickly and easily create animated intros and outros for each tile. These effects can be fully automated over a customizable duration, or their duration can be manually keyframed. All animations can be automatically eased, and you can also enable motion blur for the Fly, Shrink, and Rotate animations.

When you use these controls in Create Background mode, the transparent holes through which other clips in the background show through are animated to “open or close” to reveal the contents. When
used in Create Tile mode, the actual tile and its contents are animated to fly, shrink, rotate, and/or fade to appear or disappear.

Tile Animation controls let you create automatic Intro and/or Outro animations.

Additionally, you have the ability to keyframe the Mute, Start and End Column and Row parameters, Tile Styling and Drop Shadow parameters, and other aspects of tiles in Tiles mode, either individually or all together.

In particular, the Start and End Column and Row parameters let you create tiles that span multiple grid positions, and also move tiles from one grid position to another. Without keyframing, this lets you create more kinds of layouts with asymmetric arrangements of large and small tiles. With keyframing, you gain the ability to easily create sophisticated grid-based animations to move tiles from position to position, and to have tiles expand and contract to encompass neighboring tiles in the layout, all with a minimum of keyframing.

Keep in mind that, when using multiple instances of the Video Collage effect on superimposed clips in the Timeline, once you’ve defined your overall layout and used Paste Attributes to copy a particular instance of this effect with your layout to the rest of the clips, you need only keyframe each instance of each tile within the clip it’s applied to. Furthermore, since Intro and Outro animations are applied to the entire duration of the clip, you can easily offset each Intro and Outro animation by offsetting the clips in the Timeline.
TIP: If you change the duration of clips in a stack that are creating a Video Collage effect, you can use the Synchronize Keyframing controls inGlobals mode to offset all keyframes applied to that instance of the Video Collage effect by the same amount. You could do the same thing by opening the keyframe track or Curve Editor for all Video Collage parameters in the Timeline and offsetting them that way, but this provides a quick shortcut.

Video Collage Controls

Here’s a detailed explanation of all the parameters found in the Video Collage effect.

– **Workflow:** Defines what the output of Video Collage is, depending on how you want to use it.

  – **Create Background:** Outputs a frame with holes, behind which you can position individual layers of video to show through.

  – **Create Tile:** Outputs a single tile, transformed and styled to be one element of a multi-tile layout

– **Preview Layout:** Turning on Preview Layout lets you see a graphical preview of the entire layout, and how each tile fits together. In Create Tile mode, this lets you configure how you want the layout to look before you copy the clip and use paste attributes to apply this effect to the rest of the video layers you want to arrange into a split-screen.

– **Globals/Tile buttons:** Choose between the Globals controls, which expose controls that let you adjust the overall layout, and the Tiles controls, which let you choose the currently active tile and style it.

Layout

These controls appear in Globals mode.

– **Columns:** Choose how many vertical columns worth of tiles there are.

– **Rows:** Choose how many horizontal rows worth of tiles there are.

– **Stagger Horizontally:** Lets you create an offset from one row to the next in a balanced way, so the rows are all staggered from one another.

– **Stagger Vertically:** Lets you create an offset from one column to the next in a balanced way, so the columns are all staggered from one another.

– **Rounding:** Rounds the edges of each tile in the layout. A value of 0.000 sets the edges to be square. Increasing rounding increasingly curves the corners of each tile, until a value of 1 sets the tile to be perfectly round.

Margins and Spacing

These controls appear in Globals mode.

– **Left/Right Margins:** Alters the spacing from the edge of the frame to the left and right edges of the group of all tiles. Increasing this parameter makes all tiles progressively more narrow, as they squeeze in towards the center of the frame.

– **Top/Bottom Margins:** Alters the spacing from the edge of the frame to the top and bottom edges of the group of all tiles. Increasing this parameter makes all tiles progressively shorter, as they squeeze in towards the center of the frame.

– **Horizontal and Vertical Offset:** These two sliders let you offset the group of all tiles from the center however you like.

– **Horizontal and Vertical Spacing:** These two sliders increase or decrease the spacing between each tile, making them narrower or wider as a result.
Synchronize Keyframing

These controls appear in Globals mode. They’re basically a built-in utility that lets you offset all Globals and Tiles parameter keyframes that are applied to the current effect, to account for times when you’ve done elaborate keyframing to create animated split-screen effects, and you then need to change the duration of the clip this effect is applied to. Instead of forcing you to expose the keyframes of each parameter in the Timeline in order to move them, these controls let you move all keyframes for all parameters forward or backward by a particular number of frames, all at once.

– **Offset Frames**: Lets you specify how many frames you want to offset all keyframes applied to this effect forward. Negative values move keyframes to the left.

– **Apply Keyframing Offset**: Executes the offset.

Manage Tiles

These controls appear in Tiles mode.

– **Active Tile**: This menu serves two purposes. First, it defines which tile the current clip is displayed within. This becomes important later on when you apply this effect to other superimposed clips you want to use together in a layout. However, this control also determines which tile you further customize using the Tile-based controls of the Inspector. If you enable the Open FX Overlay of the Timeline Viewer, each tile has its own overlay that lets you click a tile in the Viewer to make that the Active Tile.

– **Bring Tile Forward/Send Tile Back**: These two buttons let you rearrange the order of tiles in the Active Tile drop-down menu.

– **Manual Tile Management**: While this checkbox is turned off (the default), changing the Columns and Rows parameters automatically updates the Active Tile drop-down menu with one tile per node on the resulting grid arrangement. Turning this checkbox on lets you Add and Delete tiles manually, which lets you create more advanced layouts with overlapping tiles and asymmetric spacing between tiles.

Mute Tiles

These controls appear in Tiles mode. A single checkbox parameter, Mute Tile, lets you enable and disable the visibility of the active tile. This checkbox is keyframable, so you can animate the appearance and disappearance of different tiles to create different effects.

Custom Size/Shape

These controls appear in Tiles mode. They let you further customize layouts on a tile-by-tile basis and can also be used to quickly and easily animate a single tile to move and resize itself around the grid of the overall layout.

– **Start/End Column and Row**: These four controls serve two purposes, letting you change a tile’s position by row and column number, or enlarge a tile to encompass multiple tile row or column positions (“spanning”). To use these parameters, you must first choose which tile you want to adjust from the Active Tile drop-down menu. With the tile you want to edit active, you can then drag the appropriate sliders to create either effect, as explained below.

– **To change Tile Position**: When adjusted together so that the Start and End values are identical, they let you manually adjust the position of each tile in the grid that’s defined by the number of rows and columns you’ve set. This is particularly useful when you want to quickly keyframe animated changes to tile position, in order to jump a tile around the grid of the layout.
To make a tile span multiple positions: Setting the Start and End Row and/or Column parameters to different values changes the currently active tile to span multiple grid positions in the layout, making that tile bigger in order to create asymmetric arrangements of larger and smaller tiles. You can also keyframe these values to easily animate the effect of a tile expanding to occupy more grid positions, or shrinking from occupying several grid positions to occupying a single position.

Choose how many rows/columns and in which directions you want that tile to span. Note that if you span multiple rows or columns that have been offset, the resulting tile is enlarged to encompass the entire rectangular region defined by the outer boundaries of both offset tiles.

Custom Size/Shape: Turning this checkbox on enables the rest of the controls in this group, enabling you to set individual scale and rounding for the active tile that's selected.

Custom Scale: Lets you adjust the size of the active tile independently of the other tiles.

Custom Rounding: Lets you adjust the rounding of the active tile independently of the other tiles.

Resize Content
These controls appear in Tiles mode. They let you resize the image being fit within each tile to show exactly what you want shown.

Pan/Tilt/Zoom: These three sliders let you move and resize the video layer shown inside of the active tile to fit however you need it to.

Edge Behavior: These settings allow you to control how the edges of the video layer respond inside the tile.

Transparent: Any positioning that goes past the edge of the video is transparent, showing the Tile Color set in the Tile Styling options.

Reflect: Any positioning that goes past the edge of the video mirrors back on itself.

Wrap: Any positioning that goes past the edge of the video repeats itself.

Replicate: Any positioning that goes past the edge of the video shows a duplicate of the edge stretched to the boundary of the control, essentially filling in the remaining space with the pixels used at the extreme edges of the video clip.

Move With Tile: Defines how the image is fit into the tile when the tile size changes due to other parameters of the Video Collage effect.

Position Only: The video content in the tile only is sized using Pan and Tilt; Zoom is ignored.

Position and Scale: The video content in the tile is sized using Pan, Tilt, and Zoom.

Tile Styling
These controls appear in Tiles mode. They let you add a colored border and adjust the opacity of all tiles or just the currently active tile. These parameters are animatable.

Apply to All Tiles: When checked, this applies any changes made in the Tile Styling parameters to all tiles in the Video Collage, regardless of which tile is currently active.

Tile Border: This slider controls the width of the tile's border. It has a possible range of values from -0.250 to 0.250, where negative numbers expand the size of the border inside the tile, and positive numbers expand it outside the tile.

Tile Color: Allows you to choose the background and border color of the tile.

Tile Opacity: This slider changes the transparency of the tile itself; it does not effect the video clip inside the tile. The possible ranges are 0.000 (fully transparent) to 1.000 (fully opaque).
Drop Shadow

These controls appear in Tiles mode. They let you add and customize a drop shadow, either to all tiles or just to the currently active tile. These parameters are animatable.

- **Apply to All Tiles**: When checked, this applies any changes made in the Drop Shadow parameters to all tiles in the Video Collage, regardless of which tile is currently active.
- **Strength**: This slider controls drop shadow transparency. The possible ranges are 0.000 (fully transparent) to 1.000 (fully opaque).
- **Color**: Allows you to choose the color of the Drop Shadow.
- **Drop Angle**: Lets you set the angle that the shadow is cast from. The slider represents 360 degrees of movement from -180.0 to 180.0.
- **Drop Distance**: Allows you to set the distance that the shadow appears from its source tile. The possible values are from 0.000 to 0.200.
- **Expand**: This slider controls how far the shadow expands from its origin. The possible values are from 0.900 to 1.250.
- **Blur**: Allows you to control the amount of diffusion of the Drop Shadow. The possible ranges are 0.000 (no blur) to 1.000.

Tile Animation

These controls appear in Tiles mode. They make it easy to create simple intro/outro animations to bring all or some tiles onscreen, and to push all or some tiles offscreen, in different ways. The Animate drop-down menu determines whether this animation will be automatic or manually created using keyframes.

- **Apply to All Tiles**: When enabled, any animation that’s set up will be applied to all tiles in the layout simultaneously.
- **Animate**: This drop-down menu lets you choose between Manually Keyframing intro or outro animations or automatically creating animations to introduce or conclude a tile. The options are:
  - **Manually Keyframe**: In this mode, you must manually keyframe the four progress sliders below to create animated Intro and Outro animations.
  - **Intro Only**: Animation is automatically created to bring each tile onscreen according to the types of animation you choose from four checkboxes below. Options include: Fly, Shrink, Rotate, and Fade, in any combination. A Duration slider appears that lets you choose how long the Intro will be.
  - **Outro Only**: Animation is automatically created to send each tile offscreen according to the types of animation you choose from four checkboxes below. Options include: Fly, Shrink, Rotate, and Fade, in any combination. A Duration slider appears that lets you choose how long the Outro will be.
  - **Intro & Outro**: Animation is automatically created to bring each tile onscreen and then send each tile offscreen, according to the types of animation you choose from four checkboxes below. Options include: Fly, Shrink, Rotate, and Fade, in any combination. A Duration slider appears that lets you choose how long the Intro and Outro will be.
- **Fly Animation**: Lets you choose a direction for tiles to fly in from and fly out to.
- **Shrink Animation**: Lets you choose a method of shrinking out or in when the Fly Progress slider is animated.
- **Fly Progress**: (manual key framing only) A slider that, when animated, lets you fly a tile into or out of the frame. A value of 0.000 positions the tile in its default grid position. A value of 1.000 positions the tile entirely off screen.
– **Shrink Progress**: (manual key framing only) A slider that, when animated, lets you shrink a tile down to nothing or up to the current size. A value of 0.000 sizes the tile at its largest state. A value of 1.000 shrinks the tile to nothing.

– **Rotate Progress**: (manual key framing only) A slider that, when animated, lets you fly a tile into or out of the frame. A value of 0.000 positions the tile in its default grid position. A value of 1.000 positions the tile entirely off screen.

– **Fade Progress**: (manual key framing only) A slider that, when animated, lets you fly a tile into or out of the frame. A value of 0.000 positions the tile in its default grid position. A value of 1.000 positions the tile entirely off screen.

### Easing & Blur

These controls appear in Tiles mode. They let you adjust the easing of the tile animation created in the previous group of controls.

– **Motion and Size Ease**: These controls set the curve used for simulated momentum in animating the Tile Position and Size keyframes of the tiles.
  – **None**: No curves are applied. The animation snaps immediately from keyframe to keyframe.
  – **Linear**: No easing curves are applied; motion is neither accelerated or decelerated.
  – **In**: The animation curve starts slower and ends faster.
  – **Out**: The animation curve starts faster and ends slower.
  – **In & Out**: The animation curve starts slower, accelerates in the middle, and slows down at the end.

– **Animation Effects Ease**: These controls set the curve used for simulated momentum in animating the Tile Animation keyframes of the tiles.
  – **None**: No curves are applied. The animation snaps immediately from keyframe to keyframe.
  – **In**: The animation curve starts slower and ends faster.
  – **Out**: The animation curve starts faster and ends slower.
  – **In & Out**: The animation curve starts slower, accelerates in the middle, and slows down again at the end.

– **Ease Amount**: The relative strength of the animation curve in speeding up and slowing down. The values range from 0.000 to 1.000.

– **Motion Blur**: This slider controls the amount of motion blur added to the animation, in order to make it smoother and more organic looking. The values range from 0.000 (no motion blur), to 1.000 (maximum motion blur).

### Global Blend

– **Blend**: This slider controls the overall opacity of the entire Video Collage effect. The values range from 0.000 (completely transparent) to 1.000 (completely opaque).
Chapter 166

Resolve FX Warp

The filters in this category let you warp the image in different ways, creating procedural or custom distortion effects, some of which can be automatically animated. The Warper plug-in is a point-based free-form Warp tool.

Contents

Dent 3121
Lens Distortion (Studio Version Only) 3121
Ripples 3122
Main Controls 3122
Ripple Controls 3122
Vortex 3122
Warper (Studio Version Only) 3123
Effect Options 3124
Onscreen Controls 3125
Waviness 3126
Dent

A warp effect that creates different types of circular bowing and folding effects.

- **Dent Type**: This lets you choose from six different types of "dent" warping effects. The options are Type 1, Type 2, Type 3, Sine, Cosine, and Black Hole.

- **X and Y**: Position sliders let you offset the center of the warp.

- **Size**: This lets you adjust the diameter of the warp.

- **Strength**: This lets you adjust the extent and direction of the warp, lowering this below zero "pulls" the image into the center of the effect, while raising this above zero "pushes" the image outward to buckle according to the Dent Type you’ve chosen.

- **Edge Behavior**: This eliminates any blanking caused by negative distortion by filling black areas in one of several user-defined ways; options include Black (do nothing and leave the blanking), Reflect, Wrap-Around, and Replicate.

Lens Distortion *(Studio Version Only)*

Lets you add convex or concave lens distortion to an image, to make it warp by bulging outward or bulging inward, similar to a poorly made lens. This filter could also be used in a corrective manner, to compensate for images exhibiting barrel distortion. Additionally, the amount of distortion applied to each color channel can be varied, in order to create the effect of chromatic aberration using the curvature of the distortion you’re adding for a more accurate effect.

- **Red, Green, and Blue Distortion**: These sliders are ordinarily locked together by the Gang checkbox. When adjusted as ganged, moving these sliders to the left (negative values) increases "fisheye" distortion, while moving these sliders to the right (positive values) creates an inverted "fisheye" effect that bows the image inward rather than outward. Turning Gang off lets you set the Red, Green, and Blue Distortion sliders to different values, introducing more accurately simulated chromatic aberration to the image.

- **Fine Adjustment**: This checkbox results in the distortion sliders operating within a much smaller range, enabling more precise adjustments.

- **Edge Behavior**: The options available in this pop-up eliminate blanking caused by negative distortion by filling black areas in one of several user-defined ways; options include Black (do nothing and leave the blanking), Reflect, Wrap-Around, and Replicate.

- **X and Y Position**: These sliders let you change the center of the distortion effect.

**TIP**: To resize a clip with an extreme distortion effect that introduces blanking around the edges of the frame, you'll need to use the Zoom control found in the Node Sizing mode of the Sizing palette. Edit and Input sizing will only zoom the image within the border created by blanking.
Ripples

A warp effect that creates different types of ripples.

Main Controls

These controls govern the type of ripple and the quality of optional ripple shine that you want.

- **Ripple Shape**: Lets you choose from Circular, Square, Horizontal, Vertical, Exponential, Star, and Radial ripples.
- **Wave Shape**: Lets you choose from Sinusoidal, Triangular, Fresnel In, Fresnel Out, and Natural waves.

A set of Shine parameters lets you overlay a simulated shine on top of these ripples.

- **Shine**: A checkbox lets you turn this shine on and off.
- **Shine Direction**: Lets you add a light shine to the peaks of the ripples. Works best at low shine strength.
- **Vertical Shine Height**: Lets you adjust the thickness of the highlights running along the ripples.
- **Shine Size**: Lets you adjust the length of the highlights running along the ripples.
- **Shine Strength**: Lets you adjust the overall appearance of the shine.
- **Animate**: This checkbox, if checked, reveals a Speed slider that lets you set how quickly the ripple effect auto-animates the phase of the currently configured ripple effect, without the need to use keyframes.

Ripple Controls

A separate set of Ripple parameters lets you enable up to five overlapping ripples.

- **X and Y Position**: Lets you change the center position of each set of ripples.
- **Amplitude**: Lets you adjust the “height” of each ripple caused by this effect.
- **Frequency**: Lets you choose how many ripples are being created.
- **Decay**: Lets you adjust the falloff of the ripple effect, where ripples gradually diminish as they reach the point of decay.
- **Phase**: Lets you adjust the phase of the ripple effect relative to the center origination point. If you want to animate a ripple simply, you can also choose to keyframe the Phase parameter to create the same effect created by the Animate checkbox above.

Vortex

Vortex begins as an S shaped warp effect, but you can adjust the parameters to create many types of warping effects.

- **X and Y position**: Two sliders let you offset the center of the warp.
- **Size**: Adjusts the diameter of the warp.
- **Angle**: Adjusts the direction and intensity of the warp effect; setting Angle below 0 twists the image to the left, while raising Angle over 0 twists the image to the right.
- **Power**: Rotates the area that’s affected to create a harder border between what is warped and what isn’t.
- **Swirl**: Intensifies the effect, twisting the image into an even tighter swirling effect.
**Warper (Studio Version Only)**

The Warper is a free-form image warper that uses points, rather than a mesh or splines, to push and stretch features in an image as if they were on a sheet of rubber. While the Warper has a lot of options and settings, getting started is really easy.

To warp a feature of the image, just click on it to add a warp point, and drag to push that part of the image in the direction you want it to go. By default, warp points influence the entire image, which is pinned down at the corners. This system makes it simple to warp large regions of the image, such as when you want to warp an edge of the image to get rid of a boom dip. Warp points are gray unless they’re selected, in which case they’re white.

(Left) The original image (Right) The image warped with a single control point

To “pin down” parts of the image you don’t want to warp, Shift-click to place limiter points (which are red, pink if they’re selected). By combining warp points with limiter points, you can quickly create extremely specific warp effects to squish and stretch features in an image in any way you want.

(Left) The original image (Right) The image warped with control (gray) and limiter (red) points

As you work, you can Option-click any unwanted warp or limiter point to delete it. To start from scratch, you can click the Warper plug-in’s master reset control in the OpenFX Inspector.

Additionally, you can use the FX mode of the Tracker palette to motion track the feature you’re warping. Then, by setting the Tracking pop-up menu to FXTracker, every warp and limiter point you’ve placed will move along with the feature you’re tracking, meaning you can create warp effects that move along with someone’s face, with a car driving on the road, or with something in a shot with camera motion.

Additionally, starting in version 16, warp and limiter points can be keyframed via the Warp Scale and Warp Point Positions parameters.
Effect Options

These controls affect how warp points that you add will affect the image.

- **Warp Limits**: A pop-up menu lets you choose how to treat the edges of the image when you’re warping it. There are three modes:
  - **Corners** (the default) lock the four corners of the image in place, but allow the sides to bulge in or out as you warp and allowing blanking to creep in.
  - **Edges** locks the full width and height of all four edges in place as you warp, preventing blanking. Distance locks parts of the image that are n pixels away, but the default setting is very permissive.
  - **Manual** allows the entire image to be warped without locking any part of it, allowing for extreme warps all along an entire edge of the image, but requiring you to place at least one limiter point prior to adding a warp point.

- **Warp Sharpness**: A pop-up menu lets you choose one of three methods of interpolating how the image bends around a Warp point: Sharp, Rubber-Sheet (the default), and Rounded. Sharp produces the “most pointy” warps, while Rounded produces the most gently curved warps. Rubber-Sheet strikes a balance between the two extremes.

- **Edge Behavior**: A pop-up menu eliminates any blanking caused by warping that affects the edge of the image by filling black areas in one of several user-defined ways; options include Black (do nothing and leave the blanking), Reflect, Wrap-Around, and Replicate.
Quality: A pop-up menu lets you choose from among three methods of calculating the warping effect you’re creating: Faster, Default, and Better. Each choice is an obvious trade-off between image smoothness and performance.

Warp Scale: This slider lets you scale the overall warp effect you’re creating. Setting this to 0.000 reduces the warp effect to nothing, while raising it to the maximum value of 2.000 doubles the warp effect. Warp Scale can be keyframed to animate the warping effect.

### Onscreen Controls

The second set of controls lets you customize which of the Warper’s onscreen controls appear, with different options that make it easier to see certain things in various situations.

- **Render a reference grid:** This checkbox superimposes a reference grid over the image to make it easier to see what kind of warping you’re applying.

- **Show Warp Boundaries:** This pop-up menu has three choices for letting you see which areas of the image will be locked off by limiter points you place in the image.
  - None hides this information and is the default setting.
  - As Border shows a red line at the boundary where warping becomes locked off.
  - As Mask dims the area that’s protected from warping by limiter points.

- **Control Visibility:** This pop-up menu lets you choose whether the warp and limiter points you create are visible as you work. Show (the default) leaves all control points visible all the time. Auto Hide hides all control points whenever you’re dragging one, letting you see the image as you adjust it without having control points in the way. Hide makes all control points invisible. You can add new control points, but you can’t see existing control points to edit them.

- **Show:** This pop-up menu lets you choose how to represent warp points, and there are two options.
  - Warp Points (the default) simply shows warp points as gray dots.
  - Warp Vectors display pairs of controls connected by a line; a round dot shows the anchor, or the part of the image the warped portion of the image came from, and an arrow shows the destination, where you’ve warped that part of the image to. Seeing the anchor and destination of each warp operation can sometimes be useful when you’re doing something complex.
– **Scale Controls:** This slider lets you shrink or grow the control points or warp vector handles to the most convenient size for the task at hand.

– **Warp Point Positions:** A parameter without any controls, save for key framing controls, that lets you keyframe the position of warp and limiter points. All points are keyframes within a single parameter and keyframe track, visible in the timeline of the Edit page, or the Keyframe Editor of the Fusion and Color pages.

### Waviness

– **Waviness Type:** Lets you choose Vertical or Horizontal waviness.

– **Scale:** Lets you choose the size of the waves.

– **Strength:** Lets you adjust the amplitude.

– **Phase:** Lets you “move” the wave and is a good parameter to keyframe if you’re animating this effect manually.

– **Animate:** A checkbox that reveals a Speed slider that lets you set how quickly the Waviness effect auto-animates without the need to use keyframes.
Fairlight
The completely redesigned Fairlight Audio Core engine allows for simultaneous playback of up to 1,000 tracks with no additional hardware, and up to 2,000 tracks when used with the Fairlight PCI Audio Accelerator. It also utilizes self-learning load balancing for maximum plug-in support.

Fairlight’s increased track count meets the demanding needs of both clients and immersive formats, such as Dolby Atmos. Major studio films and series television require high track counts to accommodate complex mixes and the export of multiple deliverables. Immersive formats, such as Dolby Atmos, multiply the necessary track counts with their demands for deliverables from 7.1 up to 22.2.

This chapter covers the basic user interface controls found on the Fairlight page, where they are and what they do, in order to give you an overall orientation of how to work with this integrated audio environment.

Contents

The Fairlight Page User Interface 3130
The Interface Toolbar 3130
Showing Which Panel Has Focus 3131
The Audio Timeline 3131
Controls in the Audio Timeline 3132
Zooming Audio Waveform Height 3134
Track Layering 3135
Switching Among Multiple Timelines 3135
Toolbar 3136
Customizing Clip Display in the Timeline 3137
The Fairlight Page User Interface

In single monitor mode, the Fairlight page is an optimized look at the audio tracks of your project, with an expanded mixer and custom monitoring controls that make it easy to edit and manipulate your audio media and evaluate and adjust the levels of your program in order to create a smooth and harmonious mix.

The Interface Toolbar

At the very top of the Fairlight page is a toolbar with buttons that let you show and hide different parts of the user interface. These buttons are as follows, from left to right:

- **Media Pool**: Shows and hides the Media Pool, from which you can edit audio clips into the Fairlight page Timeline.
- **Effects Library**: Opens the Audio FX panel of the Effects Library, from which you can apply Fairlight FX, VST, and other audio effects to clips or tracks in the Timeline.
- **Index**: Shows and hides the Index and its Tracks and Markers panels. The Tracks panel lets you manage the tracks of the Timeline, showing and hiding which ones you want to work with. The Markers panel lets you see every marker in the Timeline, along with associated data, so that it's easy to browse through your markers all at once to quickly find the information you need.
- **Sound Library**: Shows and hides your sound library. There are search and filter fields to locate desired sounds. There is a playback window to audition the sounds prior to editing into the Timeline.
- **ADR**: Shows and hides the ADR section of Fairlight. Here you will find tabbed controls for List, Record, and Setup that control the functions of the ADR panel.
– **Mixer**: Shows and hides the Mixer, to the right of the Timeline, that lets you adjust various effects and levels associated with each track of the Timeline in order to create a harmonious mix.

– **Meters**: Shows and hides the Monitoring audio meters and viewer at the top of the Fairlight page.

– **Metadata**: Shows and hides the clip metadata Inspector.

– **Inspector**: Show and hides the Inspector, from which you can edit different clip attributes.

### Showing Which Panel Has Focus

Whenever you click somewhere on the DaVinci Resolve interface using the pointer, or use a keyboard shortcut to “select” a particular panel (such as in the Edit page), you give that panel of the user interface “focus.” A panel with focus will capture specific keyboard shortcuts to do something within that panel, as opposed to doing something elsewhere in the interface. A highlight appears at the top edge to show you which panel has focus so that you can keep track of which part of the current page is taking precedence, and you can switch focus as necessary to do what you need to do.

The focus indicator shown at the top edge of the Media Pool, shown next to a Viewer that doesn’t have focus

### The Audio Timeline

The heart of the Fairlight page, the Audio Timeline, presents the audio channels and tracks of the currently selected Timeline differently than the Edit page does, in a one-channel-per-track format that’s optimized for audio mixing and sweetening. The Audio page Timeline cannot be closed.

The Audio page Timeline
Controls in the Audio Timeline

The Audio Timeline has the following controls.

– **Timecode fields and Range buttons:** Four timecode fields show the current timecode value corresponding to the position of the playhead (at the very top), the Range In point, the Range Out point, and the Range duration. Clicking the Range In and Range Out buttons (to the left of the timecode fields) set these points and their corresponding timecode value.

![Timecode fields and Range buttons in the Fairlight page](image)

– **Transport controls:** The bar defining the top of the Timeline contains the Fairlight page’s audio-specific transport controls, which differ from those found on the Media, Edit, Color, and Deliver pages due to its inclusion of recording capabilities. These include Fast Reverse, Fast Forward, Play Forward, Stop, Record, Loop, and the Automation toolbar display icon.

![Fairlight page transport controls](image)

– **Automation toolbar:** Clicking this button opens a secondary toolbar with all the controls you need to configure the recording of mixer automation.

![Fairlight page automation toolbar](image)

– **Monitoring controls:** At the far right of the transport controls, a set of three monitoring controls let you quickly control the output volume of your mix. The speaker icon is an Enable/Disable button allowing for muting audio playback. The icon turns red when audio is muted. The slider lets you change the monitor volume and has a decibel indicator of the amount of level that has increased or decreased. The DIM button lets you temporarily duck the monitored volume being output in order to have a quick chat with your client about sports or the state of the world while keeping half an ear on the mix. The slider turns yellow when audio monitoring is dimmed. Dim and Mute commands are also available from the Fairlight menu.

![The monitoring controls](image)

– **Timeline Ruler:** The Timeline Ruler shows the program's timecode. The playhead indicates the current frame and sample where you’re working in the Timeline, and the playhead has a handle that appears within the Timeline Ruler. Dragging within the Timeline Ruler moves the playhead. When you add markers to the Timeline, these markers appear within the Timeline Ruler, as well.
- **Playhead**: Shows the current frame and sample of playback, and provides a visual representation of where you are while playing, shuttling, and jogging through the Timeline. Also used as a reference point for editing operations. The largest timecode display at the upper left-hand display shows the position of the playhead.

- **Audio tracks**: The Fairlight page of DaVinci Resolve supports multiple audio tracks, and each audio track may contain multiple lanes with which to accommodate the audio channels that are contained within multi-channel audio clips using track mappings such as stereo, 5.1, 7.1, Atmos, or Adaptive (1–24 channels). All audio clips that have been edited into the Timeline appear within each track, with the recorded channels within each clip occupying as many lanes as that clip has available. At the left of each track is a header area that contains a number of controls.

![Fairlight timeline track controls](image)

The Fairlight timeline is divided into tracks and lanes; track A1 has a single lane for the mono audio within it, and track A2 has two lanes to accommodate stereo audio.

- **Track header**: The track header contains different controls for selecting, locking/unlocking, and soloing/muting tracks. Each track header also lists how many clips appear on that track. The track header contains the following five controls, from left to right:

  - **Track color**: Each track can be color-coded with one of 16 different colors. These color codes correspond to the Edit page Mixer, and to the Fairlight page Mixer and Audio Meters. You can choose a new color for any track by right-clicking the track header and choosing from the Change Track Color submenu. You can set multiple tracks to the same color by Command-clicking in the track header of multiple tracks to select them, and then right-clicking one of the selected track headers and choosing from the Change Track Color submenu.

  - **Track number**: Indicates the number of each track.

  - **Track name**: Each track has a name that defaults to the track number, such as Track 1, Track 2. However, you can click any track’s name and edit it to be whatever you like. For example, you can rename each track with the type of audio you’re editing onto it, such as Production, Ambience, SFX, or Music. These track names are also used to identify each track’s channel in the Mixer, in the middle of each channel strip (each channel strip’s track number is simultaneously displayed at the top).

  - **Audio channel type indicator**: Audio tracks also show which channel configuration that track uses, listing the number of channels for mono, stereo, 5.1, 7.1, Atmos, adaptive, and others.

  - **Fader value**: A field displays the current fader setting at the position of the playhead, in dB.
– **Lock Track button:** Light gray when turned on, dark gray when turned off. When a track is locked, clips can’t be replaced, moved, or otherwise edited, although clips on locked tracks can be graded when in the Color page.

– **Arm button:** This button arms recording onto that track.

– **Solo button:** Disables all other tracks but the current one, enabling you to quickly hear a single track in isolation. This affects rendering, so if one or more tracks are soloed, the muted tracks won’t be output or rendered.

– **Mute button:** Temporarily disables audio on that track so it’s neither monitored nor output. This affects rendering, so if one or more tracks are muted, they won’t be output or rendered.

– **Audio meters:** Each track has audio meters in the track header that let you see levels during playback.

– **Toolbar editing tools:** The toolbar contains both modal and command buttons to let you work on your projects. More detail on these appears in the following section.

– **Vertical and horizontal scroll bars:** If your project is longer than the current width of the Timeline, or the number of audio tracks is taller than the current height of the Timeline, these scroll bars let you drag to navigate around your program. When you scroll horizontally, you also move the playhead. You may also scroll vertically using the scroll wheel (or other scroll control) of your mouse or other pointing device. You may scroll horizontally by holding the Command key down while using your scroll control.

– **Individual Timeline track resizing:** Any track in the Timeline can be individually resized by right-clicking anywhere within that track’s header control area and choosing a track height from the Lock Track Height To submenu of the contextual menu. You can choose a fixed size including Micro, Mini, Medium, Large, Extra Large, and Custom. When you choose a fixed track height, vertical zooming no longer affects that track until you change that track’s Lock Track Height to option back to None.

![Resizing an individual audio timeline track using contextual menu options](image)

**Zooming Audio Waveform Height**

You can zoom into or out of the audio waveforms shown in each clip of one or more tracks, to make them taller or shorter, or you can reset them to unity. This doesn’t change the audio levels of clips in affected tracks, it just lets you make the audio waveforms easier to see. When zooming into sample level of a clip, the zero crossing of the samples will display.
To zoom audio waveform height using your scroll wheel:

– Hold down Command-Option, and roll the scroll wheel or control up or down to resize all waveforms in all tracks.

You can also use commands that are accessed by right-clicking any track on the Timeline and choosing a command from the Track Waveform Zoom submenu of the contextual menu. You can also select multiple tracks and resize their waveforms all at once. There are three sets of commands:

– Reset Zoom All/Selected Tracks
– Zoom In All/Selected Tracks
– Zoom Out All/Selected Tracks

Track Layering

Audio layering is a special audio editing mode that lets you superimpose multiple audio clips in the same track, with audio clips edited into the top layers muting overlapping sections of audio clips appearing on lower layers. With audio layering enabled, superimposed audio clips are treated similarly to superimposed video clips that have opacity set to 100%, with clips on top obscuring (or muting) clips underneath.

Turning on track layers opens up space to edit more audio into each track

Audio layering is incredibly useful for any situation where you’re combining segments of multiple takes together to create a single voiceover, audio vocal track, ADR, or dramatic performance, as you can choose which segments to use via their superimposed position in the stack of clips appearing in that track, while at the same time you’re preserving the other takes underneath in case you might want them later.

TIP: Track layering can be enabled for audio tracks on the Edit page as well.

Switching Among Multiple Timelines

Timelines can be organized like any other clip in the Media Pool. To open or switch among timelines, use the following procedures. Each Timeline retains the view settings last made within it, including track heights, zoom settings, etc.

To switch timelines, do one of the following:

– In the Edit page Media Pool, double-click a timeline.
– In the Edit page Timeline Viewer, choose a timeline from the Timelines drop-down menu at the top of the viewer.
– In the Color page, choose a timeline from the Timelines drop-down menu at the top of the viewer.
– In the Fairlight page, choose a timeline from the Timelines drop-down menu to the left of the transport controls.
Toolbar

The Toolbar has buttons that let you choose modes of functionality and other buttons that let you execute commands such as placing markers and flags.

![Buttons in the Fairlight Page toolbar]

- **Normal Edit mode**: The default mode in which you can move and resize clips in the Timeline, roll edits, and do other basic editing tasks. While this mode can be used with the pointer, it’s designed for letting you make automatic selections of clips at the position of the playhead in selected tracks, using keyboard shortcuts or the Fairlight Editing console.

- **Range Selection mode**: An editing mode in which you can select partial regions of one or more clips for partial editing. While this mode can be used with the pointer, it’s designed for letting you make automatic selections using In and Out points to define regions of selected tracks, using keyboard shortcuts or the Fairlight Editing console.

- **Edit Selection mode**: A multi-function editing mode that’s optimized for pointer-based editing in the GUI. Multiple selection and editing functions like trimming, fades, clip level, and more can be accessed by clicking or dragging on different regions of audio clips in the Timeline with this one tool. Additionally, an important aspect of working in Edit Selection mode is that this is the only mode that lets you edit the Timeline during playback, which you can’t do in Selection and Range modes.

- **Pencil**: A tool with which you can write automation data using the pointer as a pencil. The Pencil tool appears when automation is enabled.

- **Add Cut**: Click to add a cut to every clip on an unlocked track that intersects the position of the playhead.

- **Snapping**: Enables or disables clip snapping. When turned on, clip In and Out points, markers, and the playhead all snap to one another for reference while you’re editing.

- **Automation Follows Edit**: Enables or disables automation that is unique to a timeline to be embedded into the clips so that when cutting and pasting new instances of them in the Timeline they retain the levels, panning, filter settings, etc. This is extremely useful when making multiple instances of the same audio clips throughout an edit. The Automation Follow Edit button appears when automation is enabled.

- **Flag Clip/Flag Colors drop-down menu**: Flags identify clips, and indicate all clips that correspond to the same item of media in the Media Pool. Clips can have multiple flags. Clicking the Flag button automatically adds a flag to whichever clip is currently selected in the Timeline. A drop-down menu to the right lets you choose differently colored flags, and clear all flags from the currently selected clip.

- **Add Marker/Marker Colors drop-down menu**: Markers identify specific frames of individual clips. Clicking the Add Marker button adds a marker of the currently displayed color to the clip at the position of the playhead in the Timeline. A drop-down menu to the right lets you choose differently colored markers, and clear all markers from the currently selected clip.

- **Transient Detection**: Enables transient detection on a track’s set of clips. Once enabled a transient button appears on a track to enable the transients on the track’s clips to be easily identified and navigated. When the Jump to Transient button is enable the Up and Down arrow keys navigate transients within a clip.

- **Timeline View Options drop-down menu**: Contains a variety of controls with which to customize the display of clips in the Timeline.
Selecting the Audio Timeline View options

- **Timeline Options**: The left button lets you display or hide the video tracks in the current timeline, for use as a reference while you work. The button to the right of that lets you set the playhead to be fixed, so that during playback the tracks scroll past the playhead as it remains in place, which is useful when working with the Fairlight control surface. The button to the right of that lets you toggle full waveforms on and off, optionally hiding the divider bar that keeps the waveform separate from the file name area of each audio clip, so the waveform occupies the full space of each audio bar in the Timeline. The far right button lets you toggle waveform outlines on and off, drawing a dark border around the edges of each waveform to make them easier to see.

- **Scroller**: Three buttons let you turn on one video and two audio scrollers, which act as scroll bars and zoomed-in visual references for the video and audio media immediately surrounding the playhead.

- **Navigation Options**: The four buttons let you navigate the Timeline with the Up or Down Arrow keys, and one or more of these modes can be on at one time. They are Jump to Clip, Jump to Fade, Jump to Marker, and Jump to Transient.

- **Zoom Presets**: These buttons let you choose from one of 7 zoom levels.

- **Zoom Height slider**: Lets you change the height of all tracks and clips in the Timeline at once.

- **Zoom Width slider**: Lets you shrink or expand the width of the contents of the Timeline.

**Customizing Clip Display in the Timeline**

Choose Fairlight > View Clip Info Display to open a dialog with which you can customize what information is shown at the bottom of each clip in the Fairlight Timeline. This dialog has options for viewing the clip name versus the display name, and for choosing from among a variety of metadata that you might want available as you work.
There are a variety of ways you can customize the Timeline to better see what you’re working on.

**Fixed Playhead Mode**

Turning on the Fixed Playhead mode in the Timeline View Options drop-down menu, or choosing View > Show Fixed Playhead, puts the Fairlight timeline into an audio-centric mode where the playhead remains fixed in place, and the Timeline scrolls underneath it as you use the transport controls or JKL to play, shuttle, or scrub forward or back.

**NOTE:** When the Keyboard Customization has changed from the default DaVinci Resolve mapping, many key commands are altered. For instance, the Pro Tools Keyboard Customization does not offer JKL transport.

**Visible Video Tracks**

A checkbox in the Timeline View Options drop-down menu of the toolbar lets you display small versions of the video tracks in the Fairlight timeline, for reference. These video tracks are uneditable; they’re simply there so you can see which audio clips correspond to which video items, and so they can be used as snapping targets for positioning audio.

**Video and Audio Scrollers**

Checkboxes in the Timeline View Options let you optionally show one Video Scroller and up to two Audio Scrollers at the bottom of the Fairlight timeline.
At the default Low zoom level, the Video Scroller provides a scrollable frame-by-frame filmstrip view of the video of your program, where one frame of the scroller equals one frame of your video. Each of the two Audio Scrollers, on the other hand, let you focus on a continuous waveform view of a particular audio track. You choose which track populates an Audio Scroller via a drop-down menu in the Timeline header.

What Are They Used For?
The Audio Scrollers always provide a zoomed-in view of specific audio tracks that you’re focused on, regardless of the zoom level of the Timeline tracks above. This means you can focus on subtle details of the audio of one or two tracks that you’re working on, while the rest of the Timeline shows you the overall stack of tracks with clips that are playing together at that moment.

Meanwhile, the Video Scroller always shows the exact frame of video that corresponds to the current moment in time, so it’s an aid to precision editing involving frame-specific adjustments.

Additionally, both the Filmstrip and Waveform viewers scroll continuously during playback, giving you a preview of what visual actions and audio cues are coming a few moments forward in time that you can refer to while performing automation or recording foley.

Repositioning the Scroller Playhead
While the scrollers are visible, the Scroller playhead can be dragged to the left or right in the Timeline to give you more or less preview room to the right.

Zooming the Video Scroller
Right clicking on the Video scroller lets you choose a Low, Medium, or High zoom level. At Low, you get a frame-by-frame view of the program that feels like scrolling a strip of film on a Steenbeck. At Medium and High, you get a progressively abbreviated film strip that lets you zoom more quickly.
Scrolling the Fairlight Timeline Using the Scroller Tracks

Dragging the scroller tracks to the left or right smoothly scrubs through the Timeline in greater detail, regardless of the zoom level of the Timeline tracks above.

Mixer

The Audio Mixer provides a set of graphical controls you can use to assign track channels to output channels, adjust EQ and Dynamics, add filters and Fairlight FX, set levels and record automation, pan stereo, surround and immersive audio, and mute and solo tracks.

The Audio Mixer exposes two sets of channel strips with controls that correspond to the tracks in the Timeline. The leftmost set of channel strips expose one set of controls for each track in the Timeline, while the rightmost set of channel strips expose another set of controls for each bus you’ve created to bus the mixed audio tracks to your set of desired output tracks.

- **Track color**: Each track can be differently color-coded, to help you keep organized.
- **Track number**: The number of the Timeline track corresponding to each channel strip appears here.
- **Input**: A drop-down menu that lets you patch inputs, patch buses, and configure the input settings of audio signals routed through Blackmagic hardware interfaces.
- **Effects**: Fairlight FX, VST, and Audio Unit effects that you apply to tracks from the Effects Library appear here, with controls for enabling/disabling each effect, opening an effect’s custom controls, and deleting that effect.
- **Insert**: Enables the routing of effects from Blackmagic audio interface hardware to outboard effects boxes and back again. This button can be toggled to enable/disable such routing.
– **EQ**: Double-clicking exposes a four-band parametric equalizer with additional Hi and Lo Pass filters, that has both graphical and numeric controls for boosting or attenuating different ranges of frequencies of audio on each track. You can select from among four types of EQ filtering from the Equalizer Type drop-down menu, with options for Earth (the default), Air, Ice, and Fire. These four equalizer types affect the curves aspect and Q-factor of the transfer function. Each band has controls for the filter type (Bell, Lo-Shelf, Hi-Shelf, Notch), Frequency, Gain, and Q-factor (sharpness of the band), with the available controls for each band of EQ change depending on the filter type.

![The channel strip EQ window](image)

– **Dynamics**: Double-clicking exposes a set of dynamics controls with three sets of controls corresponding to an Expander or Gate, a Compressor, and a Limiter that can be used separately or in concert to manage the dynamics of the audio on that track.

![The channel strip Dynamics control window](image)

– **Bus Send**: Lets you route that track’s channels through an Aux send bus. Each Aux bar corresponds to a specific Aux bus that you created. Double-clicking any of these bars opens up the Bus Sends window, with which you can enable or disable auxiliaries, set each one to be routed Pre the channel strip or Post the channel strip (the default), and set the Send level and Pan value.
The Auxiliaries control window

Whatever level you set for an Aux bus will be shown in the bar that represents that Aux bus in the Mixer’s channel strip.

The Auxiliaries levels shown in the channel strip of the Mixer

- **Pan**: A pan control compatible with stereo and surround panning. You can drag within this control to adjust pan, or you can double-click to expose a pan window. What controls are available in the pan window depend on the mapping of the audio track, but both stereo and surround panning controls are available, with corresponding numeric controls.

The Pan control window

Option-double-clicking on the Pan control of the Mixer opens an alternate 3D Audio Pan window. Whereas the regular Pan window lets you do stereo and conventional 5.1 and 7.1 surround panning, the 3D Audio Pan window lets you do the kind of spatial audio positioning enabled by advanced surround formats such as Dolby Atmos, Auro 3D, and NHK 22.2.
The 3D Pan window

- **Bus Outputs**: These buttons let you assign a track or Sub's channels to one or more of the main buses.
- **Group**: These buttons let you assign that track's channels to up to 10 Groups as well as assign a VCA.
- **Track name**: This mirrors the track name found in the header controls of the Timeline. You can customize a track’s name in the Mixer by double-clicking and typing in the name field.
- **dB**: Shows you the volume, in decibels, that track is currently set to.
- **Arm, Solo, and Mute buttons**: Identical to the controls found in the track header controls of each timeline audio track. Arm lets you enable a track to be recorded onto. Solo lets you mute all other tracks in order to play that track in isolation (along with any other Soloed tracks). Mute disables audio playback from that track.
- **Automation**: Enable/disable automation per track.
- **Level Indicator**: This is a real time graphical representation of a track's signal measured from -60db to 0db.
- **Fader**: Each track's vertical faders let you adjust the level of that track, and perform automation recording.

The Monitoring Panel

The Monitoring panel that runs along the top of the Fairlight page shows all of the audio meters corresponding to the tracks in the Timeline, as well as the Master Output meter, control room meters, and a video viewer.
At left, a row of audio meters corresponds to the channel strips of the Mixer, one meter for every audio track in the Timeline. Each track displays the number of meters that corresponds to that track’s audio mapping, with mono tracks having a single audio meter, stereo tracks having two, 5.1 tracks having six, and so on. All of these track and bus meters (with the exception of the Loudness meters) display both peak and RMS (root mean square) levels against a dB scale.

To the right of the Track meters are the Bus meters, in which all Mains, Subs, and Aux buses appear, separated by type, and each displaying the number of meters that corresponds to that track’s audio mapping. This way you can see the sum of all tracks that have been routed to a particular bus.

The last set of meters, to the right of all others, are the Loudness meters, which consist of two sets of meters and a numerical readout. These meters let you keep track of the integrated loudness of the overall mix, which is the standard to which all contemporary mixing specifications refer when describing the deliverables you’re expected to provide to the client.

**Absolute and Relative Measurement Scales**

While some users prefer to measure their levels to correspond to a relative scale of “0,” similar to a VU meter where the needle rides above the “0,” others want to see the absolute measure of the amplitude in LUFS and true peak. By default, the Loudness meter is set to relative scale, but you now have the option to choose between relative scale and absolute scale in the Loudness meter.

Relative scale in the Loudness menu is relative to the selected scale, so a loudness unit of 0 corresponds to the target of the chosen measure type. For instance, if EBU R128 is selected, whose target measure is -23dB LUFS, the “0” LU (Loudness Unit) is equal to -23dB. If ATSC A/85 is chosen, whose target is -24dB, then that becomes the corresponding equivalent of the relative LU of 0.

When using the absolute scale, the Loudness meter displays the increments to reflect the chosen measure type. In absolute scale the EBU R128 meter will display -23 instead of the relative scale’s 0.

The option in the Loudness panel reveals the various measure types as well as the option for absolute scale.

With the additional track counts now available with DaVinci Resolve, a double height level monitor is available by double-clicking anywhere in the track field.
**Viewer**

A small viewer to the left of the Monitoring panel shows the frame of video at the position of the playhead. A button in the lower right-hand corner lets you expand the Viewer into its own floating window. The Fairlight page has Cinema Mode viewing (Command > F) or through the Workspace menu, Workspace > Viewer Mode > Cinema Viewer.

The Monitoring panel

**The Media Pool**

In the Fairlight page, the Media Pool serves as the repository of all audio clips in your project, both clips that appear within the Timeline, and clips that you’ve added to your project but have not yet used. When you record audio into the Timeline, the resulting clips are stored in the Media Pool as well, for future use. The Media Pool is also mirrored on the Media and Edit pages, and contains all of the video clips and timelines within that project.

The Bin list at the left shows a hierarchical list of bins used for organizing your media, which is also used to organize your timelines. By default, the Media Pool consists of a single bin, named “Master,” but you can add more bins as necessary to organize timelines and clips by right-clicking anywhere in the empty area of the Media Pool and choosing Add Bin. You can rename any bin by double-clicking on its name and typing a new one, or by right-clicking a bin’s name and choosing Rename Bin. The Bin list can be hidden or shown via the button at the upper left-hand corner of the Fairlight page toolbar.

The Media Pool in Thumbnail mode showing audio clips
The browser area to the right shows the contents of the currently selected bin in the bin list. Every clip you import, every timeline you create, and every AAF, XML, or EDL file you import appears here. You can create or import as many timelines as you need within a single project.

As elsewhere, the Media Pool can be displayed in either Icon or List view. In List view, you can sort the contents by any one of a subset of the total metadata that’s available in the Metadata Editor of the Media page. Of particular interest to audio editors are columns for Name, Reel Name, different timecode streams, Description, Comments, Keyword, Shot, Scene, Take, Angle, Circled, Start KeyKode, Flags, and Usage.

For more information on using the myriad features of the Media Pool, see Chapter 17, “Adding and Organizing Media with the Media Pool.” In the sections that follow, some key features of the Media Pool are summarized for your convenience.

**Importing Media Into the Media Pool on the Fairlight Page**

While adding clips to the Media Pool in the Media page provides the most organizational flexibility and features, if you find yourself in the Edit or Fairlight pages and you need to quickly import a few clips for immediate use, you can do so in a couple of different ways.

To add media by dragging one or more clips from the Finder to the Fairlight page Media Pool (macOS only):

1. Select one or more clips in the Finder.
2. Drag those clips into the Media Pool of DaVinci Resolve, or to a bin in the Bin list.
   
   Those clips are added to the Media Pool of your project.

To use the Import Media command in the Fairlight page Media Pool:

1. With the Fairlight page open, right-click anywhere in the Media Pool, and choose Import Media.
2. Use the Import dialog to select one or more clips to import, and click Open.
   
   Those clips are added to the Media Pool of your project.

For more information on importing media using the myriad features of the Media page, see Chapter 17, “Adding and Organizing Media with the Media Pool.”

**Media Pool Preview Player**

The Media Pool has a preview player at the top that provides a place to open selected source clips in the Media Pool, play them, add marks to log them, and set In and Out points in preparation for editing them into the Timeline via drag and drop. The Media Pool Preview Player effectively acts as a Source monitor for editing in the Fairlight page.

![The preview player in the Media Pool](image-url)
– Various viewing controls populate the title bar at the top. A drop-down menu at the upper left lets you choose a zoom level for the audio waveform that’s displayed. To the right of that, a Timecode window shows you the duration of the clip or the duration that’s marked with In and Out points. Next to the right, a real-time performance indicator shows you playback performance. In the center, the title of the currently selected clip is shown, with a drop-down menu to the right that shows you the most recent 10 clips you’ve browsed. To the far left, a Timecode field shows you the current position of the playhead (right-clicking this opens a contextual menu with options to change the timecode that’s displayed, and to copy and paste timecode).

– The center of the Media Pool Preview Player shows you the waveforms in all channels of the currently selected clip, at whatever zoom level is currently selected.

– Transport controls at the bottom consist of a jog bar for scrubbing, Stop, Play, and Loop buttons, and In and Out buttons.

Bins, Power Bins, and Smart Bins

There are actually three kinds of bins in the Media Pool, and each appears in its own section of the Bin list. The Power Bin and Smart Bin areas of the Bin list can be shown or hidden using commands in the View menu (View > Show Smart Bins, View > Show Power Bins). Here are the differences between the different kinds of bins:

– **Bins**: Simple, manually populated bins. Drag and drop anything you like into a bin, and that’s where it lives, until you decide to move it to another bin. Bins may be hierarchically organized, so you can create a Russian dolls nest of bins if you like. Creating new bins is as easy as right-clicking within the bin list and choosing Add Bin from the contextual menu.

– **Power Bins**: Hidden by default. These are also manually populated bins, but these bins are shared among all of the projects in your current database, making them ideal for shared title generators, graphics movies and stills, sound effects library files, music files, and other media that you want to be able to quickly and easily access from any project. To create a new Power Bin, show the Power Bins area of the Bin list, then right-click within it and choose Add Bin.

– **Smart Bins**: These are procedurally populated bins, meaning that custom rules employing metadata are used to dynamically filter the contents of the Media Pool whenever you select a Smart Bin. This makes Smart Bins fast ways of organizing the contents of projects for which you (or an assistant) has taken the time to add metadata to your clips using the Metadata Editor, adding Scene, Shot, and Take information, keywords, comments and description text, and myriad other pieces of information to make it faster to find what you’re looking for when you need it. To create a new Smart Bin, show the Smart Bin area of the Bin list (if necessary), then right-click within it and choose Add Smart Bin. A dialog appears in which you can edit the name of that bin and the rules it uses to filter clips, and click Create Smart Bin.

Showing Bins in Separate Windows

If you right-click a bin in the Bin list, you can choose “Open As New Window” to open that bin into its own window. Each window is its own Media Pool, complete with its own Bin list, Power Bins and Smart Bins lists, and display controls.

This is most useful when you have two displays connected to your workstation, as you can drag these separate bins to the second display while DaVinci Resolve is in single screen mode. If you hide the Bin list, not only do you get more room for clips, but you also prevent accidentally switching bins if you really want to only view a particular bin’s contents in that window. You can have as many additional Bin windows open as you care to, in addition to the main Media Pool that’s docked in the primary window interface.
Filtering Bins Using Color Tags

If you’re working on a project that has a lot of bins, you can apply color tags to identify particular bins with one of eight colors. Tagging bins is as easy as right-clicking any bin and choosing the color you want from the Color Tag submenu.

For example, you can identify the bins that have clips you’re using most frequently with a red tag. A bin’s color tag then appears as a colored background behind that bin’s name.

Once you’ve tagged one or more Media Pool bins, you can use the Color Tag Filter drop-down menu (the drop-down control to the right of the Bin List button) to filter out all but a single color of bin.

To go back to seeing all available bins, choose Show All from the Color Tag Filter drop-down.
Sorting the Bin List

The Bin list (and Smart Bin list) of the Media Pool can be sorted by bin Name, Date Created, or Date Modified, in either ascending or descending order. Simply right-click anywhere within the Bin list and choose the options you want from the Sort by submenu of the contextual menu.

You can also choose User Sort from the same contextual menu, which lets you manually drag all bins in the Bin list to be in whatever order you like. As you drag bins in this mode, an orange line indicates the new position that bin will occupy when dropped.

Filtering Clips With Audio in the Fairlight Page

The Media Pool in the Fairlight page has one additional feature: the ability to filter out audio-only clips, or clips with audio, in the currently selected bin. This makes it easy for you to find audio clips that you’re looking for, which are hidden along with lots of video clips in the same bin. To use this feature, click the Option menu of the Media Pool and choose Show All Clips, Show Audio Only Clips, or Show Clips With Audio.
Effects Library

The Effects Library on the Fairlight page displays both the built-in Fairlight FX audio plug-ins that accompany DaVinci Resolve on macOS, Windows, and Linux, as well as whatever Audio FX are available on your workstation.

- Fairlight FX are built-in audio processing effects that are fully cross-platform on all platforms DaVinci Resolve supports.
- On macOS and Windows, DaVinci Resolve supports the use of third-party VST audio plug-ins.
- On macOS, DaVinci Resolve supports Audio Unit (AU) audio plug-ins.

Once you install third-party effects on your workstation, they appear in this panel of the Effects Library alongside the Fairlight FX that are always available. Audio plug-ins let you apply effects to audio clips or entire tracks worth of audio, to add creative qualities such as echo or reverb, or to take care of mastering issues using noise reduction, compression, or EQ.

Similar to the Media Pool, the Effects Library’s Bin list can be opened or closed using a button at the top left.

Effects Library Favorites

You can click on the far right of any transition, title, or generator to flag that effect with a star as a favorite effect. When you do so, the favorited effects appear in a separate Favorites area at the bottom of the Effects Library Bin list.
**ADR**

The Fairlight page of DaVinci Resolve has a sophisticated interface for doing ADR, or automated dialog replacement, in a structured and straightforward manner. Simple yet powerful cue list management, industry-standard audio beeps and visual cues, and sophisticated take management with star ratings and layered take organization help you manage the resulting recordings to use the best parts of each take in your program.

When open, the ADR interface consists of three panels to the left of the Timeline: a Record panel, a List panel, and a Setup panel. The controls of these panels are described in the order in which they’re used.

### The Setup Panel

As its name implies, the Setup panel is where you configure your ADR session. It presents the controls letting you set up which audio input you want to use and what tracks to listen and record to, as well as preferences governing what the actors will see on the display you output video to, to help them keep their performance in sync.

![The Setup panel of the ADR interface](image)

### The List Panel

This is where you create a list of cues you need to re-record, either from within the Fairlight page, or imported from a .csv file that someone provides you. It presents controls for adding, editing, importing, and exporting cues that you want to record.
The List panel of the ADR interface

The Record Panel

This is where you actually run the ADR recording session you’ve set up, using the dialog cues you’ve put into the Cue list. It presents controls for displaying and selecting which cues to record, previewing and initiating recording, and adding metadata to rate the different takes you’ve recorded and to keep track of which cues have been completed.

For more information on using the ADR panel, see Chapter 171, “ADR (Automated Dialog Replacement).”
Sound Library Browser

A Sound Library panel is available from the Interface toolbar for browsing sound effects libraries that you have available to you, on your system or on a SAN you’re connected to. It includes the capability of scanning specified file paths to catalog available sound files and their metadata, storing this data within the currently selected project database (or another database that you select) to use when searching for the perfect sound effect within your library. Once you’ve cataloged your sound effects collection, it’s easy to search for sounds, preview what’s been found in the list, and edit the one you like best into the Timeline.

TIP: You can download the Fairlight sound library, a royalty-free collection of over 500 professionally recorded foley sounds that you can use in your own projects, which are directly downloadable from the Sound Library panel. The Fairlight sound library features everything from atmospheric ambient sounds to foley sounds such as foot steps, explosions, hits, effects, and more. This free sound library is designed to work with the Fairlight foley sampler, which lets you use a MIDI keyboard to trigger sounds so they can be recorded at precisely the right time in your program.
Library Controls

Clicking the Library button (to the right of the Search field) reveals a menu that lets you choose which database to use for searching (and cataloging) sound effects collections. Each PostgreSQL database can have a different catalog.

![Sound Library]

Choosing a library to search

**NOTE:** The Sound Library is now capable of using the Mapped Mount option in the Media Storage panel of the Preferences, in order to access sound effects located on remote volumes using other operating systems.

To catalog all audio files within a given file path for searching using the Sound Library:

1. Using the Project Manager, create an empty PostGres database in which to store the sound effects catalog.
2. Open a project, open the Edit or Fairlight pages, and open the Sound Library.
3. **(Optional)** Click the Library button (to the right of the Search field), and select the PostgreSQL-based project database you created to save the resulting metadata analysis to, using the Library drop-down menu that appears. The current database is selected by default. If you’re working within a disk database instead, the top compatible PostgreSQL database in the list will be the default.
4. Do one of the following:
   a. If you’ve not yet connected a library of sound effects, an Add Library button appears in the center of the Sound Library. Click this button, and from the file dialog that appears, select the top-most directory of a file path that contains sound effects; if you’ve selected a directory with subdirectories inside, each subdirectory will be examined for content.
   b. If you’re adding more sound effects to an existing library, then click the Option menu and choose Add Library. From the file dialog that appears, select the top-most directory of a file path that contains sound effects; if you’ve selected a directory with subdirectories inside, each subdirectory will be examined for content.
5. Click Open.

A progress bar will show you how long the operation will take. When you’re finished, a dialog will appear letting you know how many clips were added to the current library.

Display Controls and the Search Field

The Sound Library title bar has controls for sorting the sound effects list, showing it in List or Icon view, and an Option menu with various other settings and commands.

![Display controls]

Display controls let you choose how the contents of the Sound Effects list are viewed
Underneath, a text field lets you enter search terms, while a drop-down menu to the right lets you choose whether to search the current database for sound effects by name, description metadata, or all.

**The Search field and Filter By menu**

**To search for a specific sound effect and edit it into the Timeline:**

- Type a search term into the Search field. The case of search terms is ignored, except for boolean operators.

To help you to eliminate false positives, the search field supports different kinds of searches, such as literal searches, and/or/not boolean searches, wildcard searches, and ranges of characters.

**NOTE:** If you want to perform boolean searches, the boolean operators must be typed in all upper caps, such as AND, OR, and NOT. In lower caps, and, or, and not will be treated as search terms.

**Or/And/Not Searches**

Simply typing words separated by a space is treated as a series of OR searches for each word independently of one another, either literally or as part of another word. For example, if you type either of the following:

`car  door`
`car OR door`

both yield the same results. Every sound effect in your library containing either the letters “car” or “door” (or both) will appear, whether these letters appear independently, or within other words. Results will include files such as “CarExDoorClose,” “Doormouse_Squeak,” “Carburetor dropped on cement,” and “Carpet Shake.”

Using AND (it must be upper caps) lets you specify multiple criteria for a search, when each file that’s returned should contain every word you type somewhere within, in any order. For example, if you type:

`car AND door`

every sound effect in your library containing both the strings “car” and “door” will appear, even if these words appear either singly, in combination, or within other words, such as “NewCarDoorSlam” and “Carpet_Footsteps_Indoors,” and “GarageDoorHitsCar.”

Using NOT lets you omit sound effects that have a particular word. For example, if you type:

`car NOT door`

only sound effects with “car” will appear, and all sound effects with “door” will be omitted.
Literal Searches
Using quotations specifies a literal search for only the specified term, separated from other text by a space. For example, if you type:

“cat”

every sound effect in your library with the standalone word “cat” appears. Sound effects with “cats” and “caterpillar” will be omitted. Results will include “Space cat drone” or “Cat meowing.”

Wildcard and Range Searches
The * (asterisk) specifies a wildcard search of any number of characters. Adding an * between two search terms identifies any sound effect with the two search terms connected by any number or combination of characters with no spaces (even no characters). For example, if you type:

close*door

results include “Door-Wood Cheap-Wooden-Closet-Door-Kick-In-Flimsy-Rattle,” “ElevatorCabinCloseDoor,” and “LatchSwingCloseSqueakDoorSecur.” If you instead type:

door*close

results include “DoorHvyMetalCloseSlam,” “DoorLidWoodenChestCloseAntique,” and “ElevatorDoorCloseSlam.” If instead you type:

c*r

results include “lectrohummin,” “KiaShumaEXTBootCloseTrunkaka,” and “Ambience with Piana, Louder.”
The ? (question mark) specifies wildcard search specifying only a single character. The number of question marks you type specifies how many characters of wildcard searching you want to perform. For example, if you type:

door?close

you may get no results at all, unless you have a sound effect named “door-close.” However, if you type:

door????close

results include “DoorWoodClose” since the word wood is four letters, matching the number of wildcard letters you’ve specified.

Preview and Audition Controls
Selecting an item in the Sound Effect list loads it into the preview player where you can play it or audition it in your timeline using the controls underneath the search field.

– Clip name: The name of the current clip you’ve selected.
– Next/Previous buttons: Two buttons let you select the next or previous sound effect clip in the Sound Effect list.
– Zoom control: Controls the zoom level of the Playthrough waveform.
– Duration field: Shows the duration of the current clip, or of the section of the clip marked with In and Out points.
– Playhead timecode field: The timecode of the playhead’s position.
– Navigation waveform: The waveform of the entire sound effect appears here, making it easy to jump to different parts of the selected clip. All channels are summed together in this display.
– **Playthrough waveform**: A zoomed-in section of the selected clip that lets you see more waveform detail for setting In, Out, and Sync points.

– **Jog bar**: Lets you scrub around the clip.

– **Transport controls**: Stop, play, and Loop buttons let you control playback, although you can also use the space bar and JKL controls. Right-click the Stop button to switch it into “Stop and Go to Last Position” mode.

– **Marking controls**: The Sync Point button lets you mark which frame of the sound effect you want to use to sync to a frame of the Timeline when you audition. In and Out points let you mark how much of the sound effect clip you want to edit into the Timeline.

– **Audition controls**: The Audition button puts you into Audition mode where the currently selected sound effect clip appears at the position of the playhead in the currently selected Timeline track. Cancel and Confirm buttons let you choose whether you want to remove the clip from the Timeline and try again with another clip, or leave the sound effect clip in.

### Auditioning clips you've found in the Timeline:

1. Select a sound effect clip you've found from the list that you want to audition in the Timeline.
2. In the Sound Library, use the scrubber bar to move the playhead to the part of the sound effect that you want to sync to, and click the Sync Point button to place a sync mark on that clip. For example, if you're syncing the sound effect of a car door closing, you might sync the first frame of the door fully closed to the peak of the “slam” sound effect, rather than any door squeaking earlier in the sound effect.
3. Set In and Out points to define the range of the sound effect you want to potentially use.
4. Select a track you want to preview the sound effect in by clicking its track header or Mixer channel strip.
5. Position the playhead at the place in the Timeline you want to align the sync mark you set in Step 2.
6. Click the Audition button in the Sound Library. That clip now appears, temporarily, in the Timeline, and you can play through that section of the Timeline to see how you like the sound effect in context with the rest of the mix.
7. If you like the sound effect, click Confirm to keep it in the Timeline. If you don't, click Cancel, and it will disappear from the Timeline.

### Sound Effect List

All sound effect clips that match the current search criteria appear in this scrollable list. Double-clicking anywhere on an item of this list plays that sound effect in its entirety.

– **Clip Name**: The name of that sound effect file in the storage system.

– **Description**: Any metadata that’s embedded within the files of professionally created sound effect libraries appears here.

– **Duration**: The duration of that sound effect file.

– **Channel Mapping**: The number of channels in that sound effect file.

– **Star rating**: A clickable control you can use to rate sound effects within DaVinci Resolve. Star rating information is not saved outside of DaVinci Resolve.

– **Waveform**: The overall waveform of the entire sound effect library is stretched or compressed within the available width of the Sound Library, regardless of the actual duration of each clip.
Index

The Index provides a handy interface for listing all of the clips in the current edit, all the tracks in the current Timeline, and all the markers in the current Timeline. Using these lists, multiple items can be selected, tracks can be managed, and marker notes can be consulted with ease. Each of these three categories of information is displayed in separate panels.

Edit Index

Displays the Edit Index as seen in the Edit page. Each audio clip in the currently open Timeline corresponds to a row in the Edit Index, with columns for video track, Source In and Out, Record In and Out, Name, and other descriptive metadata. All selected clips (including clips that are automatically selected because they intersect the playhead) are selected in the Edit Index. The Option menu lets you filter the Edit Index by various criteria, for example showing only clips with a particular color of flag, marker, or color, only clips with speed effects, only clips with audio filters, or compound audio clips.

Tracks

Every track in the currently open Timeline corresponds to a row of controls and information in this panel. From left to right, each track has a color control, a visibility control, a number, a name, track controls, a format, ADC, Tags, and a numbered VCA group that it belongs to. These controls can be used to hide or show tracks, color code them, rename them, turn track controls on singly or by dragging over several at a time, change their format, and rearrange them (by dragging one or more rows up and down this list).

If you have MPEG-H enabled for immersive audio authoring, additional columns appear in this panel.
When MPEG-H is enabled in the Project Settings, the Tracks panel shows additional columns of information for defining each track in the Timeline.

These columns include:

- **Track Type**: Allows definition of either a static component or a dynamic object. When dynamic is selected, the dynamic track-level pan automation from that track is also exported. Only a track can be set to dynamic.

- **Kind**: A content type label, such as Mixed content, Music, Dialogue, Effect, etc. When Kind is defined for a bus (rather than the default state of Undefined), that bus is automatically bounced during the export process.

- **Language**: The content-specific language for that track.

- **Switch Group**: Allows the track to be assigned to a user-defined switch group. A switch group allows the track to be grouped together with other tracks in the final content, forming a selectable item when rendered. For example, a switch group of dialogue, containing an English and a Chinese language track, could allow the user to select between these languages on playback. In order to define a switch group, click that track’s cell in the Switch Group column, and choose “Sw Groups...” to open the Switch Groups Manager window, which lets you create new switch groups.

Once one or more groups has been created, they’re available for selection in the drop-down menu of any cell in the SW Groups column. This lets you quickly make a variety of custom assignments.
The drop-down in the SW Group column

- **Presets**: Allows a track to be assigned to a user-defined preset. For example, a Bed Mix and Language switch group could form one preset, while the same tracks and a spoken subtitle could form another. In order to define a Preset, click that track’s cell in the Presets column, and choose “Presets...” to open the Preset Manager window, which lets you create new Presets.

Once one or more presets has been created, they’re available for enabling in the drop-down menu of any cell in the SW Groups column. Any track can be added to multiple presets, so the Presets drop-down contains one checkbox per preset so you can make multiple assignments.
Once configured, the metadata from these presets form how the content is exported in the final deliverable, so there will be a set of presets that contain all configured components and switch groups.

**Markers**

The markers panel can be displayed in either thumbnail or list mode. In thumbnails mode, each marker in your timeline corresponds to a thumbnail displaying the timecode of its location underneath it, and the color of the marker to the left of the timecode location. In list view, each marker displays a row with the following information; marker number, frame (showing a thumbnail), marker name, start timecode, end timecode, duration, marker color, and notes.

![Markers panel](image)

The Markers panel shows a row of information for each of the markers in the Timeline.

**Inspector**

When you add an audio effect to a clip or a track, those effects appear in the Inspector when that clip or track is selected.

**Metadata Editor**

Lets you view and edit the metadata of selected clips in the Fairlight page.

**Test Tone Settings for Generating Tone, Noise, and Beeps**

The Fairlight page has a general purpose oscillator, the settings of which you can customize by choosing Fairlight > Test Tone Settings. This opens the Test Tone Settings window that you can configure to generate tones, noise, or beeps using five sets of controls:

- **Enable/Disable Test Tones toggle:** Lets you turn the Oscillator on or off system-wide.
- **Frequency dial:** Sets a custom frequency of oscillating tone, from 20 Hz to 10kHz. Defaults to 1kHz.
– **Frequency buttons:** Lets you quickly select 100, 440, 1K, or 2K preset tones, or a continuous rising sweep of frequencies from 1 Hz to 15 kHz.
– **Noise type buttons:** Two buttons let you choose from White noise or Pink noise.
– **Level dial:** Sets the output level for the tone or noise, from –50 dB to +10 dB. Defaults to –15 dB.

You can set up the Oscillator to output whatever kind of tone or noise you require, and then patch it to tracks for recording tones, or patch it to audio outputs for calibrating speakers. If you use the beep options of the ADR panel, those are performed via the Oscillator.

**To play the Test Tone out of your speakers:**
1. Choose Fairlight > Patch Input/Output to open the Patch Input/Output window.
2. Choose System Generator from the Source drop-down menu, and choose Audio Outputs from the Destination drop-down menu.
3. At the left, click the button of what you want to output, Osc (Oscillator) or Noise.
4. At the right, click the connected audio outputs that you want to patch to, and click Patch. Tone or noise should immediately start playing out of your configured speakers. Depending on any particular track’s I/O settings, if you have patched the Osc through a track you may need to either Arm the track by pressing the R button, or in the channel’s Path Settings press the Thru button, to have the signal pass for output monitoring.
5. To stop, select one of the patched buttons, and click Un-Patch.

**To record a tone or noise from the Oscillator to an audio track:**
1. Choose Fairlight > Patch Input/Output to open the Patch Input/Output window.
2. Choose System Generator from the Source drop-down menu, and choose Track Input from the Destination drop-down menu.
3. At the left, click the button of what you want to output, Osc (Oscillator) or Noise.
4. At the right, click the connected audio outputs that you want to patch to, and click Patch. Close the Patch Input/Output window.
5. Click the Arm Record (R) button in the track header of the track you patched the Oscillator to. If your Main is properly patched to your outputs, you should hear the tone or noise, and that track’s audio meter should immediately rise to the level being output by the Oscillator.
6. Click the Record button of the transport controls to initiate recording of that tone to the patched track. Click the Stop button or press the Spacebar to halt recording when you’re done.

### Pro Tools AAF Import

DaVinci Resolve can import AAF projects and media from Pro Tools, enabling you to move an audio project from a Pro Tools workstation to a Fairlight workstation. AAF import supports the import of embedded audio and track automation. To do so choose File > Import Timeline > Import AAF/EDL/XML.

### Dual Monitor Layout

The Audio page has a dual monitor layout that provides maximum space for the mixer and audio meters on one screen and a full-screen timeline on the other.

**To enter dual screen mode:**
– Choose Workspace > Dual Screen > On.
To switch which UI elements appear on which monitors:
- Choose Workspace > Primary Display > Display 1 or Display 2, which reverses the contents of both monitors in dual screen mode.

Customizing the Fairlight Page

The default layout is quite efficient for a number of tasks on most displays. You can always return to the default layout by choosing Workspace > Reset UI Layout. However, the Fairlight page can be customized to create more room for specific areas of the interface to accommodate different tasks.

To resize any area of the Fairlight page:
- Drag the vertical or horizontal border between any two panels to enlarge one and shrink the other.
To resize the height of individual audio tracks:
– Move the pointer to the bottom border of any audio track header, and when it becomes a resize cursor, drag that border up or down to resize that track. Each track can have an independent size when you do this.

To resize any column of the Index:
– Move your pointer over the divider between any two columns and drag when the horizontal resize cursor appears.

To rearrange Index columns:
– Drag the header of any column to the left and right to move that column.

**Undo and Redo in DaVinci Resolve**

No matter where you are in DaVinci Resolve, Undo and Redo commands let you back out of steps you’ve taken or commands you’ve executed, and reapply them if you change your mind.

DaVinci Resolve is capable of undoing the entire history of things you’ve done since creating or opening a particular project. When you close a project, its entire undo history is purged. The next time you begin work on a project, its undo history starts anew.

Because DaVinci Resolve integrates so much functionality in one application, there are three separate sets of undo “stacks” to help you manage your work.

– The Media, Edit and Fairlight pages share the same multiple-undo stack, which lets you backtrack out of changes made in the Media Pool, the Timeline, the Metadata Editor, and the Viewers.
– Each clip in the Fusion page has its own undo stack so that you can undo changes you make to the composition of each clip, independently.
– Each clip in the Color page has its own undo stack so that you can undo changes you make to grades in each clip, independently.

In all cases, there is no practical limit to the number of steps that are undoable (although there may be a limit to what you can remember). To take advantage of this, there are three ways you can undo work to go to a previous state of your project, no matter what page you’re in.

**To simply undo or redo changes you’ve made one at a time:**
– Choose Edit > Undo (Command-Z) to undo the previous change.
– Choose Edit > Redo (Shift-Command-Z) to redo to the next change.
– On the DaVinci control panel, press the UNDO and REDO buttons on the T-bar panel.

**TIP:** If you have the DaVinci control panel, there is one other control that lets you control the undo stack more directly when using the trackballs, rings, and pots. Pressing RESTORE POINT manually adds a memory of the current state of the grade to the undo stack. Since discrete undo states are difficult to predict when you’re making ongoing adjustments with the trackball and ring controls, pressing RESTORE POINT lets you set predictable states of the grade that you can fall back on.

You can also undo several steps at a time using the History submenu and window.
To undo and redo using the History submenu:

1. Open the Edit > History submenu, which shows (up to) the last twenty things you’ve done.

2. Choose an item on the list to undo back to that point. The most recent thing you’ve done appears at the top of this list, and the change you’ve just made appears with a check next to it. Steps that have been undone but that can still be redone remain in this menu, so you can see what’s possible. However, if you’ve undone several changes at once and then you make a new change, you cannot undo any more and those steps disappear from the menu.

Once you’ve selected a step to undo to, the menu closes and the project updates to show you its current state.

To undo and redo using the Undo window:

1. Choose Edit > History > Open History Window.

2. When the History dialog appears, click an item on the list to undo back to that point. Unlike the menu, in this window the most recent thing you’ve done appears at the bottom of this list. Selecting a change here grays out changes that can still be redone, as the project updates to show you its current state.

3. When you’re done, close the History window.
Chapter 168

Setting Up Tracks, Buses, and Patching

One of the first things you need to do when you’re setting up a new project for mixing in the Fairlight page is to define all of the audio tracks and buses you’re going to need that route and combine the audio being output. This chapter covers how to create audio tracks, and how to use buses to manage your mixes in the most efficient possible way. Rest assured, however, that Fairlight offers many options once your work has begun to change whatever needs it at will.

The new FlexBus structure completely upgrades Fairlight’s bus capabilities, offering users the option for bus-to-bus, track-to-bus, or bus-to-track signal routing. All of these additional tracks and Flexbus features have expanded Fairlight’s Dolby Atmos capabilities to include the import, export, and manipulation of Atmos ADM files.

Contents

Audio Tracks
What Is a Bus? 3168
Bus to Bus Routing and Mixing 3168
Types of Buses 3169
Buses in Nested Timelines 3170
Exposing Bus Tracks in the Timeline 3170

Controlling Signal Flow 3170

Managing Audio Tracks
Defining Timeline Audio Track Channels at Creation 3171
Creating Tracks 3171
Rearranging Tracks 3171
Changing How Many Channels an Audio Track Has 3171
Deleting Tracks 3172
Audio Tracks

Each audio track in a Resolve timeline corresponds to a single channel strip on the Mixer’s left side. Depending on how an audio track has been configured, each audio track is assigned a specific audio format, such as mono, stereo, LCRS, 5.1 surround, or 7.1 surround so that multiple audio channels within the clips on that track can be correctly routed to the proper audio output for monitoring and rendering via the lanes that can be seen within each track on the Fairlight timeline.

(Top) Stereo audio in the Edit page represented by a single track; (Bottom) The same stereo audio in the Fairlight page shows the two lanes that correspond to each of the stereo audio tracks
Audio tracks in DaVinci Resolve have been designed to contain multiple channels of clip audio within a single track, but how those individual audio channels are displayed depends on the page. The Edit page hides these individual audio channels, displaying only a single clip in the timeline to make it easier to edit multi-channel sources without needing to manage a huge number of tracks. However, the Fairlight page has a unique track and lane system for displaying audio.

The Fairlight page displays the same number of tracks as the Edit page, but each track on the Fairlight page is divided into lanes, which expose each individual channel of clip audio for editing and mixing.

Now that you understand how tracks work on the Fairlight page, the next important concept you need to understand in order to unlock the power of the Fairlight page is the FlexBus, which lets you combine multiple audio tracks in different ways.

**What Is a Bus?**

In audio postproduction, a bus is essentially a destination channel to which you can route multiple audio signals (typically the audio tracks of the Timeline) so they are mixed together into a single signal that can be controlled via a single channel strip. For example, by default a single bus called a Main (named Main 1) combines the levels of every clip edited onto every track of a timeline into the signal that’s output to your speakers.

Mains are one kind of bus, but there are other kinds of buses with which you can organize the output of tracks in a timeline. For example, if you have five audio tracks into which have been edited all of the dialog audio clips for a particular program, you can route the output of all five dialog tracks to a Submix bus, which combines them so that the combined levels from all dialog tracks can be processed, adjusted, and mixed using a single channel strip of controls.

Ultimately, you’ll use multiple levels of buses to mix programs in an organized fashion. For example, individual tracks can be routed to Submix buses, as described above. Then, multiple Submixes can be routed to one or more Mains. For example, you could have four submix buses, one for German dialog, one for English dialog, one for Music, and one for Effects. You could route the German, Music, and Effects submix buses to Main 1 to output the German version of the program, and route the English, Music, and Effects submix buses to Main 2 to output the English language version of the program.

Audio tracks from the Timeline are routed to buses via each channel strip’s multiformat surround panner, so buses can be configured to accommodate specific audio formats such as mono, stereo, LCRS, 5.1 surround, or 7.1 surround, and immersive formats, such as Atmos.

**Bus to Bus Routing and Mixing**

Fairlight has a redesigned audio engine as of DaVinci Resolve 17 and has advanced capabilities in the bus structure within Fairlight. This new FlexBus structure offers complete user flexibility for bus types and signal routing, which changes the prior Main, Sub, and Auxiliary bus formats in older versions of DaVinci Resolve to now be completely user-definable. This new structure makes it possible to patch outputs and/or sends in any way you need, as dictated by your project. Each track can output to up to ten buses and sends with additional level and pan controls to a further ten buses. Buses can be sent to other buses up to six layers deep, facilitating complex stem building, processing, and allowing discrete deliverables.

User-definable buses allow for bus-to-bus, bus-to-track, or track-to-bus routing, with each bus having the ability to pass signals from mono to fully immersive formats, such as Dolby Atmos, at the user’s discretion. As with any and all of the tracks in Fairlight, these bus types can be changed at any time by the user, if needed.
The Flexbus structure allows for many different bus track types to be created or changed.

The power of the FlexBus system is that it allows users to direct signals to many different places at one time, achieving complex mixing scenarios. Perhaps you need to generate two mixes that are identical in content but need to be of different output levels. You can designate two mix buses, one with an output level of -2dB true peak and one with an output level of -10dB true peak. The final mix signal is sent to one bus that is then broken into two more buses, one with a limiter set to -2dB and one set to -10 dB, creating these two different mixes at one time.

Using Legacy Fixed Busing

If you want to work using the previous method of fixed bus mapping, you can do so for new projects by opening the Fairlight panel of the Project Settings, and turning on the “Use fixed bus mapping” checkbox. This checkbox can only be enabled in new projects in which no timelines have yet been created. Once you’ve created one or more timelines, this option is locked to whatever the project was set to. Older projects have this setting enabled by default to preserve the previous mix.

Types of Buses

FlexBus makes all buses inputs, outputs, and sends user definable. A brief discussion of typical bus types and their uses is described below.

Mains

Main buses are typically the primary output of a program; each new project you create starts out with a single Main called M1, to which all tracks are routed by default. You can add additional Mains, and you can use them however you like, as either full or partial mixes of the program you’re working on. Mains can be directly output in the Deliver page.
Submix
Sub buses are often the means by which multiple tracks of audio that belong to the same category (dialog, music, effects, ambience, and so on) are combined together so that everything in that category can be mixed as a single audio signal. Users can define every aspect of the submix as well as submixes of submixes.

Auxillary
Each channel strip includes the ability to expose bus sends, which are typically used to route audio to software or hardware effects of some kind. Typically, an audio signal is sent to the effect (or hardware) applied to that bus and then is routed back to the channel it came from. Auxiliary send signals can be connected either immediately before or after a channel strip’s fader, based on a Pre setting. Each auxiliary bus can also be configured to accommodate specific audio formats such as stereo, LCRS, 5.1 surround, or 7.1 surround.

Buses in Nested Timelines
When you nest a timeline inside of another timeline that has buses set up for mixing in the Fairlight page, all bus routings work as intended within the nested timeline, which exposes all channels of Main 1 in the enclosing timeline. In this sense, the audio of the nested timeline can be considered to be a submix that outputs its resulting audio to the audio track it’s edited onto.

Exposing Bus Tracks in the Timeline
You can expose any bus as a track in the Timeline. This makes it possible to view and edit automation that’s applied to parameters on that bus.

To show a bus in the Timeline:
1. Open the Automation controls by clicking the automation button on the Fairlight toolbar.
2. Open the Index, and click the eye button for the Main you want to see in the Timeline.
3. You can choose any automation curve you want to view by choosing it from the drop-down menu in the track header controls.

Controlling Signal Flow
The process of setting yourself up for editing and mixing in the Fairlight page involves:

– First, customizing the tracks of the timeline to be organized and configured as required.
– Second, creating the buses you need in order to organize your signal flow.
– Third, creating the buses and patching the audio tracks to them, in order to create the signal flow you need.

Managing Audio Tracks
When you’re getting ready to record or edit audio clips into the Fairlight Timeline, you need to make sure you’ve got enough tracks to do the job. The following procedures cover the different methods available for adding, removing, and rearranging tracks as you work. These commands are all available via the contextual menu that appears when you right-click anywhere in the Timeline header area (the header of the Timeline is the area to the left where each track’s various buttons and controls are located).
Defining Timeline Audio Track Channels at Creation

If you decide to create a new audio track, you have to choose what kind of audio track it will be. Right-clicking in the bottom audio portion of the Timeline track header reveals a contextual sub-menu that lets you create different kinds of audio tracks.

- **Mono**: Holds a single channel with only one lane.
- **Stereo**: Holds stereo left and right channels, with two lanes.
- **5.1**: Holds the six channels corresponding to a 5.1 surround mix, for a total of six lanes. For broadcast, SMPTE specifies Left, Center, Right, Left Surround, Right Surround, and LFE. For cinema distribution these tracks are ordered Left, Right, Center, LFE, Surround Left, and Surround Right.
- **7.1**: Holds the eight channels corresponding to a 7.1 surround mix, for a total of eight lanes. For broadcast, SMPTE specifies Left, Center, Right, Left Surround, Right Surround, LFE, Back Surround Left, and Back Surround Right. For cinema distribution these tracks are ordered Left, Right, Center, LFE, Left Surround, Right Surround, Back Left Surround, and Back Right Surround.
- **Dolby Atmos**: There are several Atmos formats available: 5.1.2, 5.1.4, 7.1.2, 7.1.4, and 9.1.6. The naming of the channel configurations in the Dolby Atmos format includes the height channels in the nomenclature. Channel configurations are presented as three digits separated by periods, such as 7.1.4. The first digit describes the number of main, or ear-height monitoring channels that surround the listener. The second digit describes the number of subwoofer channels. The third digit describes the number of height channels, which are speakers positioned on, or in the case of a soundbar pointed to, the ceiling.
- **Adaptive**: Capable of holding up to 24 audio channels, which would display up to 24 lanes within the track. An adaptive audio track can hold clips with different combinations of channels, up to the maximum number of channels allowed within that track. The number of channels allowable on a particular Adaptive track is user-definable (1–24) at the time that track is created. If you edit a clip with more channels into an Adaptive track that was created to hold fewer channels, the extra clip channels are muted.

**NOTE**: The new Flexbus structure in Fairlight enables user-definable buses. Atmos mixes call for several bus formats that are now available in DaVinci Resolve 17 (some only in the Studio version) which are 9.1.4 as well as 22.2.

Creating Tracks

There are two commands with which to create new audio tracks, and both are in the contextual menu found by right-clicking within any audio track's header controls. Add Track adds a single audio track of the type you choose from a submenu. Add Tracks lets you insert as many tracks as you like, of a type and at a position you designate using the Add Tracks dialog.

Rearranging Tracks

You can rearrange tracks by right-clicking in a track's header area and choosing either Move Track Up or Move Track Down in the contextual menu that appears. You can also move tracks in the Index by grabbing them and moving them to the desired position.

Changing How Many Channels an Audio Track Has

If you had set up your timeline with one kind of audio track, but you discover you actually need a different kind, you can change any audio track's type at any time. Just right-click anywhere in that audio track's timeline header, and choose an option from the Change Track Type To submenu of the contextual menu.
Deleting Tracks

Right-click within a track’s Timeline header and choose Delete Track. If there are clips on a track you remove, they are also deleted from the Timeline, but preserved in the Media Pool.

You can remove all empty audio tracks in the Fairlight timeline by right-clicking any track header and selecting Delete Empty Tracks from the contextual menu.

Linked Groups of Mono Tracks

Linked groups are an organizational construct that you can create only using mono tracks (other kinds of tracks such as stereo, 5.1, 7.1, Atmos, or Adaptive cannot be used for a Linked Group). Unlike a multi-channel track with lanes, a linked group of mono tracks functions as five independently editable tracks in the Timeline. However, each track is mapped just like an audio channel using one of the standard multi-channel mappings (stereo, 5.1, 7.1, Adaptive), and linked groups of mono tracks are mixed using only a single channel strip.

Linked groups are extremely useful when you’ve been given a set of six independent audio files that need to be assembled as a single surround mix, or when you have surround channels that need to be specifically re-edited on a channel by channel basis.

To create a Linked Group from individual mono tracks:

1. Create two or more Mono audio tracks that you want to group together. If you need to create a linked group with a specific channel mapping, such as 5.1, make sure you create enough tracks (in this case, 6).

2. Choose Fairlight > Link Group.

3. When the Link Group dialog appears, Mono audio tracks are represented by active buttons (all other channel mapped tracks are disabled, since they can’t be linked). Click to enable the button of every track you want to include in the group you’re about to create. Which mappings are available to use for creating your group depends on how many tracks you’ve selected.
After you’ve selected all the tracks you need to, click one of the available “Link as” buttons below. In this example, six tracks have been selected, so you could click 5.1 Film or 5.1.

When you select enough tracks, you can create groups linked as specific surround mappings.

Afterwards, the tracks you selected should turn into a single block, showing they’ve been linked.

The Link Group window shows the link indicator line next to the track names.

Depending on the number of mono channels selected, Fairlight will offer possible linking options. For instance, when ten channels have been selected, both Atmos 7.1.2 and 5.1.4 are option choices.

The Link As option is dependent on the number of channels being linked.

Close the Link Group window when you’re finished.

Once you’ve created a linked group, the mono tracks in the timeline that you linked appear with a bar to the left in the track header that spans every track that’s linked. If the tracks are tall enough, they’ll also be labeled to identify which track corresponds to which surround channel, L, R, C, Lfe, Ls, Rs, and so on. At this point, you can edit each channel of a surround mix into the appropriate track.
If you’ve edited a multi-channel audio clip onto a multi-channel track, you can convert that track and its contents into a Linked Group of mono tracks, each of which contains a single clip for that track’s channel. This can be useful if you need to fix a multi-channel surround audio clip with an incorrect track mapping. You can convert it into a Linked Group, at which point you can easily rearrange the channels.

**To create a Linked Group from a single multi-channel timeline:**

- Right-click the track header of a multi-channel audio track, and choose Convert to Linked Group from the contextual menu. This automatically creates one new audio track for each channel, all of which are linked together. For example, converting a 5.1 audio track results in six new tracks with six individual audio clips (one for each channel), all of which are linked together.

If necessary, you can also unlink a linked group to turn it back into independent mono tracks.

**To unlink a Linked Group:**

1. Choose Fairlight > Link Group.
2. When the Link Group dialog appears, select the Linked Group you want to unlink.
3. Click Unlink.
4. Close the Link Group window when you’re finished.

The variations of routing of the multi-channel files are due to the path order of SMPTE or Film standards. They are:

- L, C, R, Ls, Rs, LFE = 5.1 film order
- L, R, C, LFE, Ls, Rs, = 5.1 SMPTE order
- L, C, R, Lss, Rss, Lsr, Rsr, LFE = 7.1 film order
- L, R, C, LFE, Lss, Rss, Lsr, Rsr = 7.1 SMPTE order

**Creating Buses**

Choosing Fairlight > Bus Format opens the Bus Format window, which lets you create the buses you need (up to the limitations of your system) to organize the tracks and channels of your program.

![Bus Format Window](image)
To turn on the immersive formats, go to the Project Settings > Fairlight panel, and choose from among the appropriate options. Once enabled, the various bus types are available in the Bus Format panel.

The Bus list lets you rename the bus, choose the format of each bus (a drop-down menu appears in the Format column of each entry of the list), shows the number of channels associated with that bus, and lets you color-code each bus (a Color drop-down lets you choose that bus’s color). Simply click any item on the Bus list to select it, and choose different options from the Format and Color drop-down menus, or click on the User Name of any bus to select it, and type a custom name.

At the bottom of the list are three buttons that let you Add Bus, Duplicate, or Remove selected Buses. When you’re done modifying the available buses, you can click OK to accept the change and close the Bus Format window, Cancel to close the window (although any buses you’ve made remain in place), or Bus Assign to open the Bus Assign window. The bottom button row also has a Used tally of what has been used and what is available for your workstation.

**NOTE:** Once you’ve created one or more timelines, the busing is locked to whatever it was originally set for to retain the previous mix options. Projects created in prior versions of Fairlight will use the fixed bus mapping options.

Legacy Busing

Four buttons at the top of the legacy Bus Format window let you create any type of bus Fairlight supports. Creating a new bus, whether it’s a Main, Sub, Aux, or Multi Track, adds the new bus to the list that appears below.

The legacy Bus list works the same as the Flexbus list in that it lets you rename the bus, choose the format of each bus (a drop-down menu appears in the Format column of each entry of the list), and color-code each bus (a Color drop-down lets you choose that bus’s color). Simply click any item on the Bus list to select it, and choose different options from the Format and Color drop-down menus, or click on the User Name of any bus to select it, and type a custom name.

At the bottom of the list are two additional buttons that let you Duplicate or Remove selected Buses. When you’re done modifying the available buses, you can click OK to accept the change and close the
Bus Format window, Cancel to close the window (although any buses you’ve made remain in place), or Bus Assign to open the Bus Assign window.

**NOTE:** Text at the bottom of the window lets you know how many buses you’re using out of how many your workstation will support.

## Assigning Buses

Once you’ve created one or more buses, you’ll want to assign different tracks to specific buses, also perhaps buses to buses, buses to tracks and the final Main bus destinations. This is accomplished in the Bus Assign window, which you can open by choosing Fairlight > Bus Assign, or by clicking the Bus Assign button in the Bus Format window. The Bus Assign window allows you to do multiple bus assignments at once; these new assignments will be reflected in the Bus Outputs section on the channel strips in the Mixer.

The options in the FlexBus Bus Assign window

The top shows the Send and the Out of all of the available buses, while the bottom shows all available tracks and buses. The Bus Assign window defaults to Icon view, in which each bus and track is shown as a button, but it can be switched to List view, in which the Available Tracks section is shown as a list.

**Methods of making bus assignments:**

– **To assign a bus:** Click a button in the Buses section to select the Send or Out of that bus, and then either click or drag a bounding box over all the available tracks that you want to assign to that bus. Once assigned, the Available Tracks buttons display which Bus they’ve been assigned to. When assigned, the Bus number will be followed by an “o” or an “s” to indicate if its the send or the out of that bus.
- **To assign every track, Sub, and Aux to a bus**: Click a button in the Buses section to select that bus, and then click Assign All.

- **To clear all track assignments from a particular bus**: Click a button in the Buses section to select that bus, and then click Unassign All.

When you’re done making bus assignments, click Save.

![The Bus Assign window with legacy Fixed Busing enabled](image)

**TIP**: If you are in legacy Fixed Busing due to a prior created project, you can bring it into FlexBus mapping. Create a new project with FlexBus as well as a blank new Timeline. Then open the project to change and highlight all and then copy all in the Timeline. Show the video tracks if you want those to copy over as well. Then open the new project and copy all into the empty Timeline. Now all FlexBus mappings should be available.

**Patching Signal Paths**

While bus creation and assignment is a straightforward way of creating a cascade of routing from tracks to buses, sometimes you need to create more specific signal paths. For example, if you need to record audio to a track, you need to patch the audio input you want to record from to the track you want to record to. This, and many other scenarios, are accomplished using the Patch Input/Output window.

The Patch Input/Output window is available on the Fairlight page, the Edit page, and the Deliver page, providing patching changes on any of these pages.
Using the Patch Input/Output Window

Choosing Fairlight > Patch Input/Output opens the Patch Input/Output window, which can be displayed in either Icon or List view. This window is split into two halves, with the left half containing whichever Source controls you choose, and the right half containing whichever Destinations you choose.

Creating a Patch

By default, the Patch Input/Output window shows the available Audio Inputs as the Source, and the Track Inputs as the destination. This makes it easy to patch whatever audio source (such as a microphone connected to a USB audio interface) to a specific audio track of the timeline to prepare for recording. Patching and unpatching a source to a destination is straightforward. In the following screenshot, the Audio 1 Input from an audio interface is highlighted and is being patched to the Track labeled DX 1.

To patch a source to a destination:

1. Choose a type of source from the Source drop-down menu at the upper left-hand side of the window.
2. Click the button or list item of the source you want to patch on the left side of the Patch Input/Output window.
3. Choose a destination from the Destination drop-down menu at the upper right-hand side of the window.
4. Click the button or list item of the destination you want to patch on the right side.
5. Click the Patch button at the bottom right of the window. The source and destination will both display the connection they’re patched to.
To unpatch a source and destination pair:
1. Click a button or list item corresponding to a source or destination you want to unpatch.
2. Click Unpatch.

Choosing Source and Destination Controls
The Audio Source and Destination drop-down menus let you choose different categories of source and destination controls to patch together.

The following Source options are available:
- **Audio Inputs**: The available physical audio inputs on your workstation, for example SX-36, MADI, or system audio. Useful when patching to record audio.
- **Bus Out**: Bus Output.
- **Bus Send**: Bus master insert send.
- **Control Room Monitor Direct**: Monitor system Direct out. Post fold up/down matrix, pre the Monitor VolumeLevel/Dim/Mute.
- **Control Room Monitor Out**: Monitor system output. Post fold up/down matrix and Monitor VolumeLevel/Dim/Mute.
- **System Generator**: Oscillator outputs. Sine, Pink noise, White noise.
- **Track Direct**: Track Direct Out, can be pre or post the track fader, with an offset.
- **Track Reproduction**: This is the signal from the track playback, before any processing.

The following Destination options are available:
- **Audio Outputs**: The available physical audio outputs on your workstation, for example SX-36, MADI, or system audio.
- **Bus Return**: Bus master insert return.
- **Talk Back**: The Talkback system for patching the General Purpose Input/General Purpose Output used for talkback.
- **Track Input**: Input to the Record and Thru path; simply put, the available audio tracks in the current Timeline.
- **Dolby Atmos Send**: The internal Dolby Atmos Render; you will need to patch this manually if you are creating original content. If you import a Dolby Atmos master file, the Send patching for the bed and object tracks will be created automatically.

When using the legacy Fixed Busing, the options are a bit different. Here is how they look when that is enabled.

The following Audio Source options are available:
- **Audio Inputs**: The available physical audio inputs on your workstation, for example SX-36, MADI, or system audio. Useful when patching to record audio.
- **Track Repro**: Short for Reproduction, this is the signal from the track playback, before any processing.
- **Track Send**: Track Insert send.
- **Track Direct**: Track Direct Out; can be pre or post the track fader, with an offset.
– **MT-Bus Dir**: Multitrack Bus Direct Out; can be pre or post the multitrack bus master fader, with an offset.

– **MT-Bus Out**: Multitrack Bus Out; always post the Multitrack bus master fader.

– **Aux-Bus Send**: Aux bus master insert send.

– **Aux-Bus Dir**: Aux Bus Direct Out; can be pre or post the Aux bus master fader, with an offset.

– **Aux-Bus Out**: Aux Bus Out; always post the Aux bus master fader.

– **Sub-Bus Send**: Sub bus master insert send.

– **Sub-Bus Dir**: Sub Bus Direct Out; can be pre or post the Sub bus master fader, with an offset.

– **Sub-Bus Out**: Sub Bus Out; always post the Sub bus master fader.

– **CR-Mon Dir**: Monitor system Direct out. Post fold up/down matrix, pre the Monitor VolumeLevel/Dim/Mute.

– **CR-Mon Out**: Monitor system output. Post fold up/down matrix and Monitor VolumeLevel/Dim/Mute.

– **Main Send**: Main bus master insert send.

– **Main Dir**: Main Bus Direct Out; can be pre or post the Main bus master fader, with an offset.

– **Main Out**: Main Bus Out; always post the Main bus master fader.


– **Solo Out**: AFL and PFL Solo Bus Out; always post the respective bus master fader.

**The following Audio Destination options are available:**

– **Track Input**: Input to the Record and Thru path; simply put, the available audio tracks in the current Timeline.

– **Track Return**: Track insert return.

– **Aux-Bus Return**: Aux Bus master insert return.

– **Sub-Bus Return**: Sub Bus master insert return.

– **Main Return**: Main Bus master insert return.

– **CR-Mon In**: Input to the Monitor system’s fold up/down matrices.

– **Talk Back**: The Talkback system, showing Comm1 and Comm2.

– **Audio Outputs**: The available physical audio outputs on your workstation, for example SX-36, MADI, or system audio.

**Using a Channel Strip’s Input Menu**

The Input drop-down menu at the top of each track’s channel strip in the mixer provides some shortcuts for patching different inputs and buses to the tracks of your mix. Each option in this menu makes the Patch Input/Output window appear with various Source and Destination selections automatically set up.

**Input**

The Patch Input/Output window appears set up to let you patch different inputs (such as the system audio input) to the tracks of the timeline. This makes it fast for setting up audio inputs in preparation for recording.

**Bus**

A shortcut to open the Patch Input/Output window (discussed previously in this chapter) that lets you patch Bus Out or Bus Sends to Timeline track channels.
Path Settings

Choosing Path Settings opens the Path Settings window for that track. This window contains controls for adjusting the input level of audio signals being input via an input/output device.

The Path Settings window showing audio inputs and track inputs

These parameters control the following:

- **Mic/Instr.**: Adjusts the Mic/Instrument level for this source, from 0 to 100 dB.
  - **On**: Enables Microphone/Instrument level for this source.
  - **48V**: Enables phantom power for that input.

- **Record Level**: Controls the level going to the disk before recording. It does not affect the track when in Thru mode.
  - **Rec**: Enabling this button makes this track ready to record. Only turn this on if there is an audio source patched to the current track.
  - **Thru**: When on, this makes the affected track into the equivalent to a live feed. When enabled, this track will monitor its input, but will not respond to a record command. Only turn this on if there is an audio source patched to the current track.

- **Trim**: This parameter controls the level as the channel enters the mixer. For timeline tracks, this controls the signal coming from disk, and does not affect any current levels being recorded.

- **Direct Output**: Controls the level going from this channel to the direct output.
  - **On**: Toggles direct output on and off.
  - **Pre**: Toggles the direct output to connect either pre or post the main channel fader.

- **Insert**: Controls the insert return only. When enabled, the channel connects to its insert return, otherwise the Channel connects to the straight-through path. The insert send, on the other hand, is always active (though it must be patched somewhere before it can be heard).

**NOTE:** Insert sends and returns are only audible if patched to physical outputs or inputs, or to other paths. Sends can be sent to the input of any path in the system, and returns can come from the output or send of any path. This is done in the Patch I/O screen (press the Patch I/O button).

When using the legacy Fixed Busing, the options there are a bit different. Here is how they look when that is enabled.

Input

The Patch Input/Output window appears set up to let you patch different inputs (such as the system audio input) to the tracks of the Timeline. This makes it fast for setting up audio inputs in preparation for recording.
Aux Bus
A shortcut to open the Patch Input/Output window (discussed previously in this chapter), which appears set up to let you patch different Aux buses to specific submix and Timeline track channels.

Sub Bus
A shortcut to open the Patch Input/Output window (discussed previously in this chapter), which appears set up to let you patch different Sub (submix) bus channels to specific Timeline track channels.

Main Bus
A shortcut to open the Patch Input/Output window (discussed previously in this chapter), which appears set up to let you patch different Main bus channels to specific Timeline track channels.

Path Settings
Choosing Path Settings opens the Path Settings window for that track. This window contains controls for adjusting the input level of audio signals being input via a BMD input/output device.
Chapter 169

Transport Controls, Timeline Navigation, and Markers

The Fairlight page has unique transport control, zooming, and scrolling options not found in the other pages of DaVinci Resolve that help you to work with audio more efficiently. This chapter covers how to navigate around the Fairlight version of the Timeline.

Contents

Transport Controls and JKL Navigation 3184
Transport Controls 3184
Using JKL to Control Playback 3184
Dragging the Playhead to Scrub 3185
Looping Playback 3185
Loop Jog Scrubbing 3185
Moving the Playhead Using Timecode 3185
Clip, Marker, and Track Navigation 3187
Selecting Tracks 3187
Moving the Clip Selection 3187
Moving the Track Selection 3187
Zooming and Scrolling 3187
Setting the Zoom Level of the Timeline 3188
Scrolling Through the Timeline 3188
Using Flags 3189
Using Markers 3189
Adding Markers to Clips 3189
Adding Markers to Timelines 3190
Transport Controls and JKL Navigation

Because of the Fairlight page's audio-focused workflow, the transport and playback controls differ from those found in the Media, Edit, Color, and Deliver pages.

Transport Controls

The Fairlight transport controls are also designed to mirror their counterparts on the Fairlight control panels. They include the following functions:

- **Rewind and Fast Forward:** Initiates accelerated playback through the Timeline in either direction. Pressing either of these buttons multiple times speeds up this motion, cycling through 8x, 24x, 60x, 150x, and 360x play speeds.

- **Play:** Plays forward. Identical to pressing the Spacebar or L keys while playback is stopped.

- **Stop:** Stops playback. Identical to pressing the Spacebar or K keys while playback is engaged.

- **Record:** Initiates recording if you have an audio source patched to a track, and if that track is enabled for recording. For more information about recording, see Chapter 170, "Recording."

- **Loop:** Toggles looped playback off and on. While looped playback is on, playback will loop at the end of the Timeline, and will also loop when you use the Play In to Out command, and will continue to loop automatically until you stop playback.

- **Automation controls:** This button exposes the automation toolbar. For more information about recording automation, see Chapter 175, "Automation Recording."

Using JKL to Control Playback

The JKL keyboard shortcuts are common to many editing applications, and experienced editors know these to be some of the most useful controls for playback and editing there are. Here’s a list of the many different ways you can use these three keyboard shortcuts to play through clips and timelines as you work.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J</td>
<td>Plays 100% backward.</td>
</tr>
<tr>
<td>K</td>
<td>Stops playback.</td>
</tr>
<tr>
<td>L</td>
<td>Plays 100% forward.</td>
</tr>
<tr>
<td>Press J repeatedly</td>
<td>Increases backward play speed each time you press J, for a range of fast-reverse speeds.</td>
</tr>
<tr>
<td>Press L repeatedly</td>
<td>Increases forward play speed each time you press L, for a range of fast-forward speeds.</td>
</tr>
<tr>
<td>Shift-J</td>
<td>Plays in fast reverse.</td>
</tr>
<tr>
<td>Shift-L</td>
<td>Plays in fast forward.</td>
</tr>
<tr>
<td>K+J</td>
<td>Plays backward at slow motion (with slow motion audio playback).</td>
</tr>
<tr>
<td>K+L</td>
<td>Plays forward at slow motion (with pitch-corrected audio playback on OS X).</td>
</tr>
<tr>
<td>Pressing K while tapping J</td>
<td>Moves the playhead back one frame.</td>
</tr>
<tr>
<td>Pressing K while tapping L</td>
<td>Moves the playhead forward one frame.</td>
</tr>
</tbody>
</table>
If you’re using Fairlight with the keyboard, then this will probably become one of the main ways you move the playhead around in DaVinci Resolve.

NOTE: All of the keyboard commands listed in this document are based on the DaVinci Resolve keyboard customization preset. There is great power in the remapping of keyboard commands to systems that may be more familiar to you like Premiere Pro or Pro Tools. However, if their keyboard command set does not offer the same commands as the DaVinci Resolve keyboard commands, they won’t work the same. For instance, the Pro Tools keyboard preset does not support J-K-L timeline navigation.

Dragging the Playhead to Scrub

You can also drag the playhead left and right to scrub through the visible area of the Timeline by clicking and dragging anywhere within the Timeline ruler at the top of the Timeline, directly below the toolbar. If you’re zoomed in at a reasonable level for editing, scrubbing the playhead using your pointer will result in smooth, tape-like slow and fast audio playback, giving you a great deal of precision while trimming audio.

Looping Playback

Two controls govern looping on the Fairlight page, similarly to how looping works on the Edit page.

- **Loop**: Command-Forward Slash (/). Toggles looped playback off and on. While looped playback is on, playback initiated with any of the following commands will loop automatically until you stop playback.

- **Play In to Out**: Option-Forward Slash (/). If you’ve marked a section of a clip or timeline with In and Out points, this command lets you preview how it will play.

Loop Jog Scrubbing

Currently available only on the Fairlight page, choosing Timeline > Loop Jog enables a brief sample preview to be heard while scrubbing the playhead through the Timeline. This can make it easier to recognize bits of dialog or music as you’re quickly scrubbing through tracks, in situations where you’re trying to locate specific lines or music cues. It also enables this brief sample preview to loop endlessly when you hold the playhead on a frame, so you can pause while scrubbing and hear (by default) the current 80 ms prior to the playhead as it loops.

A pair of settings in the User Preferences let you customize this behavior.

- **Loop Jog Alignment**: Three options let you choose whether you loop audio Pre the position of the playhead, Centered on the playhead, or Post the position of the playhead.

- **Loop Jog Width**: A field lets you choose how many milliseconds of audio to loop when Loop Jog is enabled. How many milliseconds of audio corresponds to one frame depends on the frame rate of the video. For example, at a frame rate of 25 fps, there are 1000/25 = 40 ms per frame, so the default value of 80 ms equals two frames of looping.

Moving the Playhead Using Timecode

You can use absolute or relative timecode entry to move the playhead in the Timeline. Timecode entry lets you move the playhead very precisely or jump to specific timecode values really quickly.
How to Enter Timecode Values

When entering timecode, type each pair of hour, minute, second, and frame values from left to right, with a period representing a pair of zeros for fast entry. The numbers you enter appear in the timecode field at the upper left-hand corner of the Viewer with focus. When you’re finished typing, press the Return key to execute the timecode command. The rules for timecode entry are as follows:

– The right-most pair of timecode values (or period) you enter is always the frame number.
– A period to the left or to the right of any number you type is considered to be a pair of zeroes.
– A single period between two numbers is considered to either be a single zero or ignored if it’s between two pairs of numbers.
– Any untyped pairs of values to the left of what you enter are assumed to be whatever those values were prior to the timecode you entered; this makes it easy to type partial timecode values even when the Timeline starts at hour one.
– It’s not necessary to enter colons or semicolons.

Absolute Timecode Entry

Absolute timecode is entered simply by typing the timecode value you want to move the playhead to, and when you press the Return key, the playhead will move to that timecode value.

Here are some examples of absolute timecode entry using this method:

<table>
<thead>
<tr>
<th>Original TC Value</th>
<th>User-Typed Value</th>
<th>New TC Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>01:10:10:10</td>
<td>15245218</td>
<td>15:24:52:18</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>2..</td>
<td>01:02:00:00</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>15</td>
<td>01:10:10:15</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>12</td>
<td>01:10:10:12</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>1.2</td>
<td>01:10:01:02</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>1115..</td>
<td>11:15:00:00</td>
</tr>
<tr>
<td>01:10:10:10</td>
<td>23...</td>
<td>23:00:00:00</td>
</tr>
</tbody>
</table>

Relative Timecode Entry

Relative timecode is entered by starting the timecode value with a plus (+) or minus (–). Adding a plus results in the value you type being added to the current timecode value for purposes of offsetting the playhead from its current position. Adding a minus will subtract the value you type from the current timecode value.

Here are three examples of relative timecode entry:

<table>
<thead>
<tr>
<th>User-Typed Value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>+20.</td>
<td>00:00:20:00 is added to the current timecode value.</td>
</tr>
<tr>
<td>+3..</td>
<td>00:03:00:00 is added to the current timecode value.</td>
</tr>
<tr>
<td>-5</td>
<td>00:00:00:05 is subtracted from the current timecode value.</td>
</tr>
</tbody>
</table>
Clip, Marker, and Track Navigation

The Up and Down Arrow keys are used to move the playhead from one edit point to the next in the Fairlight page Timeline, just as in the Edit page Timeline.

However, holding Command-Option down while using the Arrow keys gives you Fairlight page-specific behaviors that are used to navigate among clips, markers, and tracks in the Fairlight page in a way that's different than other pages of DaVinci Resolve but very useful to the way the Fairlight page operates. This section covers the basics.

Selecting Tracks

Which tracks are selected determine the behavior of the Arrow keys.

- **In Selection mode:** You can select tracks by clicking or Command-clicking (to select multiple tracks) anywhere in the background area or on the track number of the track headers. If you click and drag in the track header, you can use a bounding box to select multiple tracks. Selection mode will not select in unused areas of the Timeline.

- **In Range Selection or Edit Selection mode:** You can select tracks by clicking or Command-clicking anywhere either in the background area or on the track number of the track header, or in any unused area of the track itself in the Timeline. If you click and drag, you can use a bounding box to select multiple tracks.

Moving the Clip Selection

The Command-Option-Left and Command-Option-Right Arrow key shortcuts are used to move the playhead left and right in the Timeline, navigating from clip to clip or from marker to marker. How these keys function depends on whether or not one or more tracks is selected in the Timeline.

- **If no tracks are selected:** The Left and Right Arrow keys will jump the playhead from Timeline marker to Timeline marker. Clip markers will be ignored.

- **If one or more tracks are selected:** The Left/Right Arrow keys will jump the playhead among clip In points, clip Out points, and Timeline markers.

Moving the Track Selection

The Command-Option-Up and Command-Option-Down Arrow key shortcuts are used to move the track selection up and down in the Timeline, changing which tracks are selected. By changing which tracks are selected, you can alter which clip’s In and Out points are used to jump the playhead around the Timeline.

If no tracks are selected, then nothing happens.

Zooming and Scrolling

The Fairlight page has several methods of zooming into and out of the Timeline, and scrolling when you’re zoomed to the point where your edited sequence of clips extends past the left and right edge of the visible timeline.

The Playhead

Zooming is always centered on the position of the Playhead. By default the Playhead moves along the Timeline as it plays. However, Fairlight offers the option of a Fixed Playhead where the Timeline moves while the Playhead remains centered.
The Fixed Playhead option is found in the Timeline Options panel.

Setting the Zoom Level of the Timeline

Depending on how you like to work, there are several methods of zooming into and out of the Timeline.

- **Using the Vertical Zoom slider:** A pair of sliders at the right of the toolbar let you zoom vertically and horizontally. The first one lets you scroll vertically in order to see more detail in the height of your waveforms. If no tracks are selected, then zooming is centered on the top audio track in the Timeline. If one or more tracks are selected, then zooming is centered on the topmost selected audio track.

- **Using the Horizontal Zoom slider:** A pair of sliders at the right of the toolbar let you zoom vertically and horizontally. The second one lets you zoom horizontally in order to see more detail in the width of your waveforms.

- **Pressing Command-Equal (=) and Command-Minus (–):** Command-Equal (also referred to as Command-Plus) and Command-Minus let you zoom horizontally into the Timeline.

- **Use Shift-Z to Zoom to Fit:** Command-Z lets you zoom horizontally to fit all clips in your program to the available width of the Timeline.

- **Using scroll controls of your pointing device to scroll horizontally:** Holding the Option key down and using the scroll wheel (or scroll control) of your pointing device will zoom horizontally into the Timeline. Holding the Command key down and using the scroll wheel will move the Timeline earlier or later than its current time, without moving Playhead.

- **Using scroll controls of your pointing device to scroll vertically:** Holding the Shift key down and using the scroll wheel (or scroll control) lets you zoom vertically in the Timeline. In this case, if no tracks are selected, then zooming is centered on the top audio track in the Timeline. If one or more tracks are selected, then zooming is centered on the topmost selected audio track.

- **Using the Fairlight panel’s Jog/Edit wheel:** If you have a Fairlight panel, you can hold the ZOOM button down while turning the Jog/Edit wheel to zoom into the Timeline at the position of the playhead.

Scrolling Through the Timeline

However closely you’re zoomed into the Timeline, if you’re zoomed enough so that clips extend past the visible area of the Timeline, scroll bars appear below. If the playhead is offscreen, a small orange tic mark indicates its position relative to the entire timeline, which is represented by the total width of the scroll bar’s background.

If you drag the playhead, or otherwise use any of the transport controls or playback key shortcuts to move through the Timeline, the contents of the Timeline refresh every time the playhead hits the left or right edge of what’s visible.
Using Flags

Flags are meant to mark an entire clip, and they also flag every other clip in the Timeline that shares the same Media Pool source clip, making this a handy way of quickly identifying which clips in a given timeline come from the same Media Pool source. Flags are visible in every page of DaVinci Resolve, making them an excellent method of tracking media from page to page.

You can apply multiple flags to clips, with a variety of colors to choose from. In addition to flagging specific media files, flags can be useful for sorting by column in the Media Pool, as well as a variety of other operations. Whenever you enter text into a flag, it displays a small dot that indicates there’s more information inside of it.

Methods for flagging clips in the Fairlight page:

– To flag a clip: Select one or more clips, and either click the Flag button to flag that clip with the current color, or click the Flag pop-up in the toolbar to choose a different color and then click the Flag button. In the Edit page, flags appear in the Timeline superimposed in the name bar of each clip.

– To remove all flags from a clip: Select one or more clips with flags you want to remove, then click the Flag pop-up in the toolbar, and choose the top “Clear All” option.

– To change the Flag color or remove individually: Double-click the Flag icon on the clip and a Marker dialog box appears to change the Flag color, remove the flag, or make a note regarding the flag.

Using Markers

Markers are used to call attention to a particular frame within a specific clip. Markers can be individually colored, and can have customized name and note text. Whenever you enter text into a marker, that marker displays a small dot that indicates there’s more information inside of it. Once placed, markers snap to In and Out points, edit points, the playhead, and other markers whenever snapping is enabled, making it easy to use markers to “measure” edits and trims that you make in the Timeline. Markers are visible in every page of DaVinci Resolve, making them an excellent method of tracking frames in clips and specific moments in the Timeline from page to page.

You can add markers to the Timeline (in the Timeline ruler) or to clips. The full procedures for placing and editing markers in the Fairlight page’s onscreen interface are identical to those for the Edit page, so for more information, see Chapter 41, “Marking and Finding Clips in the Timeline.” For now, here’s a summary.

Adding Markers to Clips

The following procedures describe how to add markers to clips in the Timeline of the Media page.
To mark a clip in the Timeline, do one of the following:

- Select one or more clips you want to mark, then move the playhead to the frame of a selected clip in the Timeline, and click the Marker button in the toolbar (or press M) to place a marker at that frame, using the current color (if multiple overlapping clips are selected, you’ll add a marker to all clips).

- To place a marker during playback and immediately open the marker dialog to enter a name or note within it, select one or more clips you want to mark, play through the selection until you want to place a mark, then press Command-M. Playback pauses until you enter some text and close the marker dialog again, at which point playback continues.

- Select one or more clips you want to mark, and then click the Marker pop-up to choose a different color, and click the Marker button.

Adding Markers to Timelines

You can also place markers of any color into the Timeline ruler to denote specific times for future reference, or add notes about issues you want to keep track of. You should note that all markers placed on clips or in the Timeline also appear within the Mini-Timeline of the Color page, making it easy to place notes to reference particular audio cues that might be valuable when editing or grading.

To mark the Timeline itself, make sure all clips are deselected, and do one of the following:

- Click the Marker button (or press M) to place a marker of the currently selected color in the Timeline ruler.

- To place a marker during playback and immediately open the marker dialog to enter a name or note within it, select one or more clips you want to mark, then press Command-M. Playback pauses until you enter some text and close the marker dialog again, at which point playback continues.

- Click the Marker pop-up to choose a different color, and click the Marker button.

- Right-click in the Timeline ruler and choose a marker color from the Add Marker submenu of the contextual menu.
Chapter 170

Recording

It’s possible to record to one or more tracks on the Fairlight page, accommodating workflows as varied as editors recording scratch voiceover or temp sound effects, recording engineers recording narration, ADR, or foley as part of the audio finishing process, music studios recording orchestras for the music score, or garage bands recording their latest magnum opus. While DaVinci Resolve is a comprehensive post-production environment for cinema and video, the Fairlight page can be used for any audio recording application you might have, from books on tape to live music to feature films and television.

Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting Up to Record</td>
<td>3192</td>
</tr>
<tr>
<td>Arming Tracks</td>
<td>3193</td>
</tr>
<tr>
<td>Choosing Where to Record Audio Clips To</td>
<td>3193</td>
</tr>
<tr>
<td>User-Selectable Input Monitoring Options</td>
<td>3193</td>
</tr>
<tr>
<td>Recording Using the Onscreen Controls</td>
<td>3194</td>
</tr>
<tr>
<td>Recording and Editing Multiple Takes Using Layering</td>
<td>3194</td>
</tr>
<tr>
<td>Recording VSTi Instruments</td>
<td>3195</td>
</tr>
</tbody>
</table>
Setting Up to Record

Depending on how your workstation is set up, it’s possible to simultaneously record to multiple tracks in the Fairlight page at once. How many tracks you can record to depend entirely on what hardware you have available. This section describes the process of recording to tracks in the Fairlight page.

Patching Inputs

Before you can record anything, you need to use the Patch Input/Output window to patch an available audio input to a track. If your computer has nothing else, the inputs of your workstation are available to connect whatever audio device is set up as the default audio input on your system to the track you want to record to.

To open the Patch Input/Output window, do one of the following:

- Choose Fairlight > Patch Input/Output.
- Click the Input menu at the top of the channel strip of the track you want to record to, and choose Input.

To patch an audio source to an audio destination:

1. Make sure that the Source menu is set to Audio Inputs, and the Destination menu is set to Track Input.
2. On the right, click the audio input that you want to patch so it’s highlighted.
3. On the left, click the audio destination that you want to patch so it’s highlighted also, if it’s not already. In this simplified example, channel 4 of the ULN is being connected to Audio 4.
4. Click the Patch button at the bottom of the window, and your recording setup will be patched.
5 Continue steps 2 and 3 until you’ve patched all the inputs you want to record from to all of the tracks that you want to record onto. You can patch as many inputs to as many tracks as your system is set up to accommodate. In this example, there are twelve available audio sources, and the first four have been patched.

6 When you’re finished, close the window.

Arming Tracks

To record on a track, it must be armed. You should note that it’s impossible to arm a track that hasn’t been patched first, so make sure you’ve patched the audio source you want to record from to the track you want to record to first. Then arming that track is as simple as clicking the R button in the track header controls, or in the channel strip for that track in the Mixer.

![Arm button turned on in the track header.](image)

Once a track has been armed, you’re ready to record.

Choosing Where to Record Audio Clips To

The process of recording in the Fairlight page creates new clips and generates additional media on disk. You can specify the location on disk where you want to save these recordings by opening the Capture and Playback panel of the Project Settings. In the Capture section use the Browse button, found underneath the “Save clips to” field, to choose a new location (a folder named “Capture” on your scratch disk is the default location).

To choose where the new clips that are created are placed in the Media Pool, simply open the Media Pool and select any bin in the Bin list, or create a new bin and select it if you want to put your recordings in their own location.

User-Selectable Input Monitoring Options

The Fairlight > Input Monitor Style submenu presents five options governing how you want to monitor inputs while recording.

- **Input:** You only hear the live signal being input; you never hear the contents of tracks.
- **Auto:** When one or more tracks are armed for recording, you hear the live input signal; on playback you hear the contents of each track.
- **Record:** You only hear the live input signal while actively recording, meaning the Record button has been pressed while one or more tracks are armed for recording. You don’t hear the input signal while tracks are merely armed.
- **Mute:** You hear nothing.
- **Repro:** While recording, you only hear what’s just been recorded, played from the track. In other words, you’re not listening to the live input, but you’re reviewing what’s just been recorded as it’s recording.
Recording Using the Onscreen Controls

You can record anywhere you want on the currently armed track or tracks by placing the playhead where you want recording to begin. In this way, you can record to specific areas of your program as you record voiceover, sound effects, foley, or other timed performances that need to fit into a particular region of the edit.

To begin recording:
1. Position the playhead where you want recording to begin.
2. Click the Record button in the transport controls. Recording immediately begins, and the material being recorded immediately begins drawing a waveform in real time, giving you immediate feedback that the input you’re recording is properly connected or not, as well as where on the currently armed track material is being recorded.

To stop recording, do one of the following:
- Click the Stop button in the transport controls.
- Press the Spacebar.

Recording and Editing Multiple Takes Using Layering

There are two ways you can record multiple takes. You can either record them one after the other, sequentially, and then edit them later. However, you also have the ability to record multiple takes to the same region of the timeline, one on top of another, while at the same time preserving every take using track layering.

In the following screenshot, multiple takes have been recorded over the same section of the timeline, including some partial takes to correct specific phrases in the voiceover being recorded. When you do this, the result looks like a series of cuts and overwritten clips, with the most recently recorded segments being the ones that play back over the previously recorded segments.

![Overlapping recordings with Audio Track Layers turned off](image)

However, if you choose View > Audio Track Layers, you’ll see that all your recordings have actually been preserved via a vertical stack of overlapping audio clips.
Overlapping recordings with Audio Track Layers turned on, showing layering within the same track

The layering of audio clips in DaVinci Resolve means that the topmost superimposed clips in a layered stack like this mutes the audio of overlapping clips that are lower in the stack.

Using layering, it’s easy to edit the best segments of the best takes, while preserving all other takes, simply by adding edits and rearranging clips in the stack so the best parts are on top.

For more information about audio layering, see Chapter 172, “Editing Basics in the Fairlight Page.”

**Recording VSTi Instruments**

DaVinci Resolve supports VSTi instruments working with connected MIDI controllers to trigger instrument sounds that can be recorded live on audio tracks of the Timeline. Davinci Resolve Studio includes the Fairlight FX Foley Sampler. This can be loaded with foley sounds such as footsteps or human movements, so you can perform these sounds in real time and record the result to another track as you watch performers walking or punching in the edit, even if you lack a recording booth with foley pits and props.

For more information about the Foley Sampler, see Chapter 177, “Fairlight FX.”
On the other hand, if you’re a musician, there’s nothing stopping you from loading VSTi musical instruments of different kinds for playback, and using the Fairlight page as a multi-track recorder. DaVinci Resolve doesn’t have MIDI sequencing functionality, but you can record live playback straight to the Timeline, using layered audio to manage multiple takes for later re-editing. Bet you never thought you’d be recording music in DaVinci Resolve....

To enable a MIDI controller in macOS:

1. If DaVinci Resolve is running, quit before connecting your MIDI controller and setting it up.
2. On macOS you’ll use the Audio Midi Setup utility to choose output hardware and select a speaker configuration to be made available on your system. In the Finder, use Spotlight and search for Audio MIDI Setup to open it.
3. In Audio MIDI Setup, choose Window > Show MIDI Studio. A window showing icons for all connected MIDI controllers appears. Your controller should be showing an icon. If it’s not, you may need to install drivers for it.
4. Select the icon for your controller and turn on the “Enter test MIDI setup mode” button (it looks like a little keyboard) to test if your keyboard is connecting with the computer. If it is, then turn this off.

For more information on setting up MIDI on different systems, see the DaVinci Resolve Configuration Guide, available on the web from the Blackmagic Design support page at https://www.blackmagicdesign.com/support/family/davinci-resolve-and-fusion.

To set up the Fairlight page for VSTi instrument recording using a sampler:

1. Open DaVinci Resolve.
2. Make sure you have at least two available audio tracks in the Timeline, one for the instrument you’ll be playing, and one to record into. This example will use tracks A4 and A5 for this.
3. Open the Effects Library, find a VSTi sampler you have installed on your system, and drag it to the track header of the track you want to use for playing, for example track A4.

Massively-featured sampler/synth combinations such as Native Instruments Kontakt and Steinberg Halion are ubiquitous and useful when you want to specifically map a collection of sound effects to specific keys or pads to create re-usable multi-purpose instruments. However, more streamlined samplers that emphasize automatic audio clip slicing such as Serato Sample (Windows and macOS) or Image Line Slicex (Windows only) can make short work of the more specialized task of loading library sound effects recordings (or custom recordings you create) with multiple footsteps, punches, keyboard presses, cloth rustles, or other foley activities, and quickly splitting them up into individually playable samples you can trigger with pads or a keyboard.
4 When the VSTi interface window appears, open the MIDI menu at the upper right-hand corner of the VSTi window and choose the correct MIDI channel from your MIDI controller’s submenu. If you’ve selected the correct MIDI channel, the instrument should start responding to the keys or pads on your controller.  

![Enabling MIDI control](image)

5 Next, configure the VSTi instrument you’re using to play the sound effects you want to use for foley. In this example, the Serato Sample VSTi plug-in is being used to automatically slice up a recording of footsteps from one of Sound Ideas’ many sound effects libraries. 

Because the VSTi you added is patched to that track’s Insert (if you look at the Mixer you should see that the I button is enabled on the channel strip the instrument is patched to), the Send is PRE the Instrument. This means you need to patch that track’s Track Direct output to the input of another track to record the instrument.  

6 Choose Fairlight > Patch Input/Output to open the Patch Input/Output window, then set the Source drop-down menu to Track Direct and the Destination drop-down menu to Track Input. Click Audio 4 to the left, and Audio 5 to the right, and click the Patch button; this sets you up to play the VSTi plug-in on track A4, and record its output on track A5.  

Be aware that after patching Track Direct from the track with the instrument to the track you’re recording onto, you also need to turn “Direct Output” on for that track in the Path Settings of that track’s channel strip in the Mixer.  

7 Open the Mixer (if necessary), click the Input drop-down menu at the top of the channel strip that shows the VSTi instrument you’re using, and choose Path Settings. When the Path Settings window appears, click the ON button for Direct Output, then close the Path Settings window.  

At this point, you’re ready to begin recording.  

To play and record a VSTi instrument:  

1 Click the Record Arming button of the track you’re recording to (in this example A5), move the playhead to where you want to begin recording, and then click the Record button to begin recording.  

2 As the video of your program plays, use your MIDI controller to trigger sound effects as necessary. When you’re finished, click the Stop button.  

If necessary, you can record multiple takes using track layering until you get the timing right. When you’re finished, you can remove the instrument from the track it’s on since the recorded audio is all you need.
The Fairlight page of DaVinci Resolve has a sophisticated interface for doing ADR, or automated dialog replacement, in a structured and straightforward manner. Simple, yet powerful, the ADR panel incorporates Cue list management, industry-standard audio beeps and visual cues, and sophisticated take management with star ratings and layered take organization to create and manage the re-recording of dialog in any program. With this sophisticated organization and layering, it’s easy to edit together the best parts of each take into your program.

Contents

ADR (Automated Dialog Replacement) 3199
The ADR Interface 3199
Setting up to Do an ADR Session 3203
Creating and Importing ADR Cue Lists 3204
Manually Creating an ADR Cue List 3204
Importing Cues 3204
Recording ADR to the Timeline 3205
ADR (Automated Dialog Replacement)

Clicking the ADR button on the Interface toolbar opens up the celebrated Fairlight ADR panel, which provides a thoroughly professional workflow for doing automated dialog replacement. Dialog replacement, for those who don’t know, is the process whereby audio professionals bring in actors to re-record unsalvageably bad dialog recordings from the comfort of their recording studios, line by line and with a great deal of patience.

It’s an old joke that ADR isn’t really automatic, but the Fairlight page aims to give you all the help it can to make this a structured and straightforward process. Simple, but powerful, Cue list management lets you efficiently assemble a re-recording plan. Industry-standard audio beeps and visual cues via your BMD video output device help the actors in the booth nail their timings and their lines. Then, sophisticated take management with star ratings and layered take organization in the Timeline help you manage the resulting recordings to pick and choose the best parts of each take when you edit the results.

The ADR Interface

When open, the ADR interface consists of three panels to the left of the Timeline: a List panel, a Record panel, and a Setup panel. The controls of these panels are described in the order in which they’re used.

The Setup Panel

As its name implies, the Setup panel is where you configure your ADR session.
This panel presents the following controls:

- **Pre Roll and Post Roll**: Specifies how many seconds to play before and after each cue’s specified In and Out points, giving actors a chance to listen to what comes before and after each cue in order to prepare. If you enable the Beep options below, beeps provide a countdown during the specified pre-roll.

- **Record Source**: (Disabled until you select a Record Track) A drop-down menu lets you choose the input you want to record from, creating a patch to the Record Track.

- **Record Track**: A drop-down menu lets you choose the track you want to record to. Selecting a track with this menu creates a patch from the Record Source to the Record Track, and automatically toggles Record Enable on.

- **Guide Track**: A drop-down menu lets you choose which track the original production audio you need to re-record is on. This is used for sending audio playback to the talent to use as a guide for recording their own replacement performance.

- **Record File Name**: A text entry field that lets you provide a name for the audio files being recorded to be saved with.

- **Character Setup**: A list for adding the names of all the characters that have dialog cues you’ll be re-recording, to help with cue creation and management. An Add New button lets you add additional names to this list, while a Remove button lets you delete characters you no longer need.

- **Beep to In Point**: Enables a three-beep sequence to be heard leading up to the recording. For beeps to be audible, the Beeps channel of the System Generator is a source that must be patched to your audio outputs using the Patch Input/Output window.

- **Beep at In Point**: Enables one last beep at the In point. For beeps to be audible, the Beeps channel of the System Generator is a source that must be patched to your audio outputs using the Patch Input/Output window.

- **Count In**: An onscreen counter that counts down to the start of the cue.

- **Video Streamer**: A visual cue for the talent to watch during pre-roll to ready them for recording. A pair of vertical lines superimposed over the program being output to video move towards one another across your video output screen during the pre-roll to the cue. This gives the talent a visual indication of the time remaining until they should begin talking. When the beeps play, these lines get taller. Both lines come together at the Time In frame, at which point a cross shows that recording is beginning.

- **Smart Timeline**: When turned on, this option automatically moves the playhead to each cue as it’s selected in the Cue list, and zooms in to frame the duration of that cue in the Timeline.

- **Mixing Control**: Enables automated switching of audio playback, to independently control what the talent and the audio engineer hear at various stages of the ADR recording process. For example, with this enabled, the Guide track is not routed to the Control room while the engineer is reviewing a take.

The List Panel

This is where you create a list of cues you need to re-record, either from within the Fairlight page, or imported from a .csv file that someone provides you.
The List panel of the ADR interface

This panel presents the following controls:

- **Cue editing controls**: Displays the data for the currently selected cue (or a cue that was just created). In and Out timecode fields store the Timeline In and Out points that were set when the cue was created but can be manually edited for fine tuning. A Character drop-down menu lets you choose which character that line of dialog belongs to. A text entry field lets you enter the dialog cue that’s to be re-recorded, so you and the talent can both refer to it.

- **New Cue button**: Clicking this button adds a new cue to the list using whatever In and Out points have been set in the Timeline, and whatever character was last selected.

- **Cue list**: The list of all cues that have been entered or imported. The Cue list can be filtered using the Filter drop-down menu at the top-right of the ADR panel (next to the option menu). You can choose to show the cues for all characters, or for any selected combination of characters. You can also choose to hide all cues that are marked as done to experience the joy of this list shrinking more and more the closer you are to being finished.

Additionally, the ADR interface option menu has three commands pertaining to the List panel:

- **Import Cue List**: Lets you import a properly formatted .csv file to create cues that have been prepared in a spreadsheet. Correct formatting for cue lists you want to import is no headers, one line per cue, with four individual columns for In timecode, Out timecode, Character Name, and Dialog.

- **Export Cue List**: Lets you export the contents of the Cue list to a .csv file, for exchange or safe-keeping.

- **Clear Cue List**: Deletes all cues in the Cue list. It’s recommended you export a copy of your Cue list before eliminating it completely, in case you ever need to revisit a cue.

**The Record Panel**

This is where you actually run the ADR recording session you’ve set up, using the dialog cues you’ve put into the Cue list.
This panel presents the following controls:

- **Record and rehearse controls**: Four transport controls and two buttons let you control recording during ADR sessions. These controls are only clickable when you’ve selected a cue from the Cue list to record.

- **Rehearse**: Runs the section of the Timeline specified by a cue without actually recording anything, giving the talent an opportunity to run through their dialog and practice their timing and delivery. Beeps and on-screen streamers are not played during a rehearsal.

- **Play**: Plays the currently selected take from the Take list (described below). If no take is selected, the most recently recorded one on top is played.

- **Stop**: Immediately stops rehearsal, playback, or recording.

- **Record**: Initiates recording of the cue to the specified audio track, with cue beeps and video streamer cues.

- **Keep Playing**: At the end of a take you may wish to keep playing, so the talent can hear the next section of the track. Pressing the Keep Playing button at any time, even while recording, results in post roll being ignored and normal playback resuming after the cue’s Out time.

- **Keep Recording**: At the end of a take you may wish to keep recording until you manually stop. Pressing the Keep Recording button at any time, even while recording, results in the Out point of the current cue being ignored and recording continuing until you stop it.

- **Take list**: The Take list shows every take you’ve recorded for the current cue, with take number, name, and a five-star rating that you can set to keep track of which takes worked and which didn’t. Earlier takes are at the bottom of this list, while recent takes are at the top (the same order in which the corresponding layered audio clips appear in the Timeline track they’ve been recorded to).

- **Cue list**: The list of all cues that have been entered or imported. The Cue list can be filtered using the Filter drop-down menu at the top-right of the ADR panel (next to the Option menu). You can choose to show the cues for all characters, or for any selected combination of characters. You can also choose to hide all cues that are marked as done to experience the joy of this list shrinking more and more the closer you are to being finished.

- **Cue list Done column**: A sixth column appears in the Record panel only, labeled Done. It contains check boxes for each cue that you can turn on to keep track of which cues you’ve successfully finished.
Additionally, the ADR interface Option menu has one command pertaining to the Record panel:

- **Record Early In**: Enables recording during pre-roll, in the event you’re working with talent that likes to start early.

### Setting up to Do an ADR Session

Setting up to record ADR is straightforward but requires a few steps.

#### Creating tracks in preparation to record ADR:

1. In the Timeline, create a new audio track to which you’ll be doing ADR recording. Make sure it has the correct channel configuration for your recording (mono is typical for dialog).
2. If you’re recording ADR to your main timeline, you may want to Solo both the Guide track and the Record track, so you and the talent can focus on the audio being re-recorded without hearing all the other tracks of the current mix.

Now you’re ready to configure the Setup panel.

#### Configuring the Setup panel:

1. Open the ADR interface, and then open the Setup panel.
2. Choose the Pre Roll and Post Roll you want to use, in seconds. A pre roll of at least 3 seconds is recommended to give the talent time to get ready.
3. From the Record Source drop-down menu, choose the microphone you patched earlier.
4. From the Record Track drop-down menu, choose the Record track you created.
5. From the Guide Track drop-down menu, choose the track with the original production audio that you’re replacing.
6. At the bottom of this panel, turn on which Preroll Cue options you and the talent want to use as you record each cue. Options include:
   a. **Beep to In Point and Beep at In Point** provide an audible count down to when to start performing.
   b. **An animated Video Streamer** gives a countdown to the start time, shows the duration of the cue being recorded, and also displays the text of the dialog for that cue on screen for the actor to refer to, so they can keep their eyes on the screen and not a script.

Next, if you’ve enabled Beep to In Point and Beep at In Point, you need to patch the Fairlight oscillator to your output channels so the talent can hear the preview beeps.

#### Patching the Oscillator to play beeps over your audio output:

1. Choose Fairlight > Patch Input/Output to open the Patch Input/Output window.
2. Choose System Generator from the Source drop-down menu, and click to select Beeps.
3. Choose Audio Outputs from the Destination drop-down, and choose the left/right outputs you want these preview beeps to play out of. You can drag a bounding box to select multiple outputs, thereby connecting the mono Beeps input to stereo output for comfortable listening.
4. Click Patch to make the connection, then close the Patch Input/Output window.
Creating and Importing ADR Cue Lists

You must have a list of cues to be able to use the ADR interface properly. There are two ways you can create a Cue list to record with, make one from scratch on the Fairlight page, or import one. The ADR panel accommodates both workflows.

Manually Creating an ADR Cue List

If you’ve been doing all of your dialog editing inside of DaVinci Resolve, you can go ahead and create a list by marking the sections of the Timeline you need to re-record and creating cues from those timings. To create cues properly, you should start by adding the names of each character you’ll be creating a cue for in the Setup panel. These names make it easier to enter cues and will help you to filter and sort the list as necessary later on.

To add character names before entering cues:

1. Open the Setup panel of the ADR interface.
2. Click Add New.
3. When a selected entry appears in the Character Setup list, type a name.
4. Press Return when you’re done.

To edit the Character Setup list, do one of the following:

– If you mis-spell a name, you can double-click any name in this list to edit it.
– To delete a name, you can select it and click Remove to eliminate it.

Once you’ve created a complete set of character names, you can begin creating your Cue list.

To manually add cues to the Cue list:

1. Open the List panel of the ADR interface. This is where all the controls for creating and editing cues are.
2. In the Timeline, set In and Out points to mark the section of dialog you want to turn into a cue. Those timecode values appear in the Cue Editing section of the List panel.
3. Click New Cue to add a blank cue to the Cue list.
4. In the Cue Editing section, choose the character who’s speaking that cue from the Character drop-down (only names that have been entered in the Setup tab appear in this list).
5. If necessary, select the text field below, and type the dialog that needs to be re-recorded.
6. Repeat steps 2 through 5 until you’re finished creating all the cues you intend to re-record. If you need to edit any cue, simply click to select that cue, and edit it in the Cue Editing section above.

Importing Cues

If you or an assistant has already created a Cue list using a spreadsheet with separate columns for character names, dialog, and In/Out timecode values, then you can also create a Cue list by importing this data from an exported .csv file.

To import a .csv file to the Cue list:

1. Choose Import Cue List from the ADR option menu, then use the dialog to choose the .csv file containing the Cue list you were given, and click Open.
An ADR Setup dialog appears, showing the data from the .csv file previewed as a series of columns. This lets you see if each column of incoming data is being assigned correctly. If it's not, you can reassign each column of the incoming data to the correct column of the ADR panel.

Correct formatting for Cue lists you want to import is to have no header text, and to enter information using one row per cue, with four individual columns for In timecode, Out timecode, Character Name, and Dialog. If any of these columns are transposed, you can correct this by choosing the correct data type for each column from the drop-down menus at top.

Click Import CSV. The cues should appear in the Cue list.

To export a .csv file from the Cue list:
– Choose Export Cue List from the ADR option menu, choose a location to save the file, and click Save.

Recording ADR to the Timeline

Once you’ve configured your workstation for recording, and you’ve set up a Cue list to work with, it’s time to start recording each cue.

To record a cue from the Cue list:
1 Open the Record panel of the ADR interface.
2 If you want to record a particular character’s cues, you can select each unnecessary character in the ADR Option menu to uncheck that character, hiding their dialog in the Cue list.
3 With the list showing the character cues you need, select the cue you want to start recording. That cue contains the timecode necessary to determine which part of the Timeline to record to, and the playhead automatically moves to that part of the Timeline.
4 Click the Rehearse button a few times to run through the cue with the talent. When you click Rehearse, both audio and video corresponding to that cue will play, including pre roll and post roll, along with all beep and onscreen cues.
When the talent is ready to try a take, click the Record button, and let the Fairlight page do the work of playing through pre roll with beep notifications and visual streamer cues, initiating recording, and then stopping recording automatically once the cue is done. To record another take, simply click the Record button again.

Every time you complete a recording, a take appears in the Take list. Making multiple recordings results in multiple takes in the list. In the Timeline, all new takes appear as layered audio, so you can record as many takes as you like into the same area of the Timeline. Once you’ve finished recording takes, you’ll have a neatly organized stack of alternate takes to draw upon as you edit together the best parts of each recording.

If you or the talent want to hear a particular take again, select it in the Take list and click Play. You can use the 5-star ratings control to keep track of how you liked each take.

When you’re finished recording a cue, click the Done checkbox for that cue, and select the next cue you want to record. When you’re finished re-recording dialog, simply close the ADR interface.
You can use the Fairlight page to refine the editing of audio that was initially assembled in the Edit page, or you can use the Fairlight page to both record and edit audio programs from scratch. Because audio clips have properties that video clips do not, audio editing encompasses additional procedures that are not available in the Edit page. This chapter takes you through the fundamental steps of editing audio the Fairlight way.

Contents

Compatible Audio Formats 3209
Editing Audio Clips Into the Timeline 3209
Overwriting Vs. Layering Clips That Overlap 3209
Choosing Parts of Clips to Edit in the Media Pool 3210
Dragging Audio Clips Into the Timeline 3210
Moving Audio Clips to Embedded Timecode Position 3212
Support for Mixed Audio Track Formats from Source Clips 3213
Making Audio Clip Selections in the Timeline 3214
Fairlight Edit Mode Remains Between Application Restarts 3214
Selecting Tracks 3215
Using Selection Mode 3216
Using Range Selection Mode 3218
Using Edit Selection Mode 3222
Commands For Editing and Extending the Selection 3224
Locking Audio Tracks You Don’t Want to Change 3225
Splitting Clips 3226
Linked Clips in the Fairlight Page 3226
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trimming Clips Without Rippling the Timeline</td>
<td>3226</td>
</tr>
<tr>
<td>Multi-Point Editing Overview</td>
<td>3226</td>
</tr>
<tr>
<td>Resizing the In and Out Points of a Clip</td>
<td>3227</td>
</tr>
<tr>
<td>Trim Start and Trim End</td>
<td>3227</td>
</tr>
<tr>
<td>Trim to Selection</td>
<td>3228</td>
</tr>
<tr>
<td>Moving and Overwriting Clips</td>
<td>3228</td>
</tr>
<tr>
<td>Slipping</td>
<td>3229</td>
</tr>
<tr>
<td>Duplicating Clips</td>
<td>3229</td>
</tr>
<tr>
<td>Disabling and Re-Enabling Clips in the Timeline</td>
<td>3230</td>
</tr>
<tr>
<td>Deleting Audio Clips and Regions</td>
<td>3230</td>
</tr>
<tr>
<td>Cut, Copy, and Paste</td>
<td>3230</td>
</tr>
<tr>
<td>Conventional Cut, Copy, and Paste</td>
<td>3230</td>
</tr>
<tr>
<td>Using the Cut/Copy Head and Tail Commands</td>
<td>3233</td>
</tr>
<tr>
<td>Paste and Remove Attributes</td>
<td>3234</td>
</tr>
<tr>
<td>Copying and Pasting Clip Attributes</td>
<td>3234</td>
</tr>
<tr>
<td>Copying and Pasting Track Attributes</td>
<td>3234</td>
</tr>
<tr>
<td>Removing Attributes</td>
<td>3235</td>
</tr>
<tr>
<td>Audio Clip Layering</td>
<td>3235</td>
</tr>
<tr>
<td>Audio Compound Clips</td>
<td>3236</td>
</tr>
<tr>
<td>Audio Crossfades</td>
<td>3237</td>
</tr>
<tr>
<td>Fades and Crossfades</td>
<td>3237</td>
</tr>
<tr>
<td>Using Fades</td>
<td>3237</td>
</tr>
<tr>
<td>Batch Fade and Crossfade Editor in the Fairlight Page</td>
<td>3238</td>
</tr>
<tr>
<td>Fade In and Out to Playhead</td>
<td>3241</td>
</tr>
<tr>
<td>Creating Crossfades With Overlapping Fades</td>
<td>3241</td>
</tr>
<tr>
<td>Using Crossfades From the Edit Page</td>
<td>3242</td>
</tr>
<tr>
<td>Finding Clips in the Media Pool</td>
<td>3242</td>
</tr>
<tr>
<td>Changing Clip Color in the Timeline</td>
<td>3243</td>
</tr>
<tr>
<td>Editing Audio Clips in External Editors</td>
<td>3243</td>
</tr>
<tr>
<td>Bouncing Audio Clips to External Files</td>
<td>3244</td>
</tr>
<tr>
<td>Multi-Channel Bouncing</td>
<td>3244</td>
</tr>
<tr>
<td>Sample Editing</td>
<td>3245</td>
</tr>
<tr>
<td>Waveform Zero Crossing Indicator</td>
<td>3246</td>
</tr>
</tbody>
</table>
Compatible Audio Formats

DaVinci Resolve is compatible with WAVE, Broadcast WAVE, AIFF, MP3, AAC (M4A), CAF (macOS only), both MTS and QuickTime containers that use the AC3 audio format, and Enhanced AC-3 (macOS and Windows only). DaVinci Resolve is compatible with audio at sample rates including 32, 44.1, 48, 88.2, 96, and 192 kHz. Linux users have the added ability to encode and decode MP3 files in Fairlight.

DaVinci Resolve 17 adds Dolby Atmos ADM file creation and manipulation as well as the ability to export Atmos masters as IMF deliverables. IMF (Interoperable Master Format) is a SMPTE standard for a single master file format that incorporates all the media and metadata necessary to deliver what's necessary.

ADM Import

Importing an ADM file into a project will open the Bed mix or mixes and any associated Object tracks into a timeline. They will be imported onto corresponding track types of the audio files embedded into the ADM. For instance, if a Bed file is 7.1.2, then on import that file will open in a 7.1.2 track in Fairlight. Object files will be created as separate tracks in Fairlight containing all of their panning data. Object tracks can only be mono or stereo files due per the Dolby Atmos specification.

Editing Audio Clips Into the Timeline

The Fairlight page offers a complete audio editing environment that lets you either record and assemble clips from scratch, or refine tracks full of audio clips that have been edited together in different ways. There are four ways of adding media to the Timeline in the Fairlight page, depending on the type of work you do:

- Recording new audio into one or more tracks (for more information, see Chapter 170, “Recording”)
- By dragging and dropping new audio clips from the Media Pool into the Fairlight timeline
- By editing audio clips into audio tracks on the Edit page
- By importing a project with audio clips
- By auditioning and confirming sound effects from the Sound Library

However audio clips come to be in your timeline, the rest of this chapter covers the myriad methods available to edit and sweeten the contents.

Overwriting Vs. Layering Clips That Overlap

When you add clips to the Timeline, what happens when you add a clip that overlaps another clip that’s already in the track you’re editing to depends on the Timeline > Layered Audio Editing setting. By default, with Layered Audio Editing turned off, overwriting one audio clip with another results in the overlapping part of the overwritten clip being non-destructively deleted from the Timeline by the incoming clip.

However, if you turn Layered Audio Editing on, then incoming clips do not overwrite overlapping clips in the Timeline; instead, they’re layered within that track, such that the incoming audio clip takes precedence over what was previously there, but overlapping audio segments that were previously in the Timeline are preserved, which can be seen when you choose View > Show Audio Track Layers.

In this way, you can choose whether you want to overwrite previously edited clips, or layer newly edited clips, as your needs require, regardless of whether or not Audio Track Layers are visible. Audio layering can be enabled in both the Edit and Fairlight pages.

For more information about audio layering, see the section later in this chapter.
Choosing Parts of Clips to Edit in the Media Pool

The Media Pool has a preview player at the top that provides a place to open selected source clips in the Media Pool, play them, add marks to log them, and set In and Out points in preparation for editing them into the Timeline via drag and drop. The Media Pool Preview Player effectively acts as a Source monitor for editing in the Fairlight page.

![The preview player in the Media Pool](image)

– Various viewing controls populate the title bar at the top. A drop-down menu at the upper left lets you choose a zoom level for the audio waveform that’s displayed. To the right of that, a Timecode window shows you the duration of the clip or the duration that’s marked with In and Out points. Next to the right, a real-time performance indicator shows you playback performance. In the center the title of the currently selected clip is shown, with a drop-down menu to the right that shows you the most recent 10 clips you’ve browsed. To the far left, a Timecode field shows you the current position of the playhead (right-clicking this opens a contextual menu with options to change the timecode that’s displayed, and to copy and paste timecode).

– The center of the Media Pool Preview Player shows you the waveforms in all channels of the currently selected clip, at whatever zoom level is currently selected.

– Transport controls at the bottom consist of a jog bar for scrubbing, Stop, Play, and Loop buttons, and In and Out buttons.

Dragging Audio Clips Into the Timeline

You can show the Media Pool in the Fairlight page, and edit audio clips into the Timeline in their entirety by dragging and dropping individual clips onto whichever audio track you want them to appear. You can drag any clip onto any track, regardless of whether or not the channels of the clip match the channel mapping of the track. However, if you edit a clip with more channels than a track has (for example, editing a stereo clip onto a mono track), only the channels supported by that track will be output, with all other channels in that clip being muted. If this happens, you can always remap the audio track by right-clicking the track header and choosing a new mapping from the Change Track Type To submenu.

**TIP:** Dragging one or more clips to the empty area underneath the existing audio tracks of the Timeline results in the creation of new tracks, each of which is automatically mapped to however many channels are required by each audio clip being edited.

If you want to edit several clips into the Timeline at once by dragging them from the Media Pool, you’ll probably want to do a bit of preparation to make sure they’re edited in the right order.
Dragging several clips into the Timeline as one contiguous series of edited clips:

1. Change the sort order of the Media Pool’s browser area to put the clips into the order in which you want them to appear. In Thumbnail view you can use the Sort Order menu, but in List view you can click the header of any metadata column to sort by that column’s data.

2. Use the Media Pool thumbnails, the Media Pool List view Filmstrip, or the Source Viewer to set In and Out points to define the part of each clip that you want to edit into the Timeline.

3. Select the Media Pool clips you want to edit into the Timeline by dragging a bounding box, Command-dragging multiple bounding boxes over different sets of clips, by Shift-clicking a range of clips, or by Command-clicking individual non-contiguous clips.

4. Drag any of the selected clips to the desired position in the Timeline to perform an overwrite edit. The clip(s) you drag overwrite whatever other clips they overlap in the Timeline. Multiple clips dragged from the Media Pool will be edited in the order in which they’re sorted in the Media Pool, using each clip’s In and Out points.

It’s possible to edit audio clips into the Timeline so that each clip’s timecode lines up with the Timeline Ruler. This can be useful if you’re organizing multiple source audio recordings that you want to synchronize together on multiple tracks.

Dragging multiple clips to edit them into a track at their timecode positions:

1. Select the Media Pool clips you want to edit into the Timeline by dragging a bounding box, Command-dragging multiple bounding boxes over different sets of clips, by Shift-clicking a range of clips, or by Command-clicking individual non-contiguous clips.

2. Hold Command-Shift down, and drag the selected clips into the track you want them to appear, to perform an overwrite edit.

Each clip edited into that track appears at the same timecode position as its embedded timecode. This means that if you were recording time-of-day timecode, each clip will appear on the Timeline at the time it was recorded. A series of clips recorded during hour 10 through 13 will appear distributed throughout hours 10-13 on your timeline.
You can also edit two or more audio clips into the Timeline as a stack, in preparation for layering multiple sound effects for doing sound design work.

Dragging multiple clips to edit them into a track as a parallel stack:

1. Select the Media Pool clips you want to edit into the Timeline by dragging a bounding box, Command-dragging multiple bounding boxes over different sets of clips, by Shift-clicking a range of clips, or by Command-clicking individual non-contiguous clips.

2. Command-drag the selected clips into a track of the Timeline. The first of the selected clips appears in the track you’re dragging to, the other clips appear either in audio tracks underneath the first one, or if there are no audio tracks available, in new audio tracks that will be created to hold those clips.

All clips you’ve edited appear as a parallel stack, in separate tracks, one on top of another.

Moving Audio Clips to Embedded Timecode Position

All clips have a timecode embedded into their metadata. There are options to place clips onto the Timeline from either the Media Pool or in the Timeline itself with this metadata.

Right-clicking a clip in the Timeline has the choice to Move to Embedded Start Timecode. When this is clicked the clip will spot onto the Timeline on a selected track with the timecode.

It’s important to be aware of the embedded timecode and the timecode in the Timeline. A clip that has an embedded timecode of 00:00:00:00, for instance, will be hard to find on a Timeline that starts at 00:59:58:00. There are many instances where the embedded timecode will not properly spot to the Timeline. If you have spotted using these tools and still don’t see the clip in question, then check the embedded timecode in the Metadata Panel of the Inspector as well as the timecode of the Timeline itself.
Right-clicking a clip in the Media Pool reveals the Insert Selected Clips to Timeline option.

Right-clicking a clip in the Media Pool has the choice to Insert Selected Clips to Timeline Using Timecode. When this is clicked the clip will spot onto the Timeline on a selected track with the embedded timecode.

**NOTE:** You can find the embedded timecode for a clip in the Inspector in the File tab under timecode.

Support for Mixed Audio Track Formats from Source Clips

DaVinci Resolve supports media with multiple audio tracks that have differently formatted channels embedded within them. For example, a clip with one stereo track, one 5.1 surround track, and six mono tracks can all be appropriately set up in the Audio panel of Clip Attributes after that clip has been imported.
The Audio panel of Clip Attributes has controls over what format (Mono, Stereo, 5.1, 7.1, Adaptive) the channels embedded within a particular audio track should be configured as. This means you can set up clips with multiple tracks, each one using different formats of audio employing different combinations of channels, which is useful for setting up imported audio mix files that you want to output when mastering a program.

Clip Attributes now lets you assign channels among different tracks with different channel assignments

Making Audio Clip Selections in the Timeline

Nearly every editing operation described in this chapter and others requires you to make a selection to define which clips will be affected. Three editing modes in the toolbar give you different ways of selecting clips, depending on what you’re trying to do, and how you like to work. These are (from left to right) the Selection mode, the Range mode, and the Edit Selection mode. Which mode you choose determines how clips and clip segments are selected in the Timeline in preparation for all manner of editorial operations.

The Selection and Range Selection tools seen in the toolbar

Fairlight Edit Mode Remains Between Application Restarts

Fairlight retains the Edit Mode the project was saved with between restarts. Whatever edit mode you were working in prior to closing the application will be active when reopened.
Why Are There Three Edit Modes?

While the Selection and Range modes can also be used with the pointer, they're really designed to enable automatic selections based on the position of the playhead. This is accomplished when using the Fairlight Editing console, the Fairlight Desktop Console, or keyboard shortcuts to control Timeline transport, while specific tracks are selected to enable selection and editing on those tracks.

The Edit Selection mode is designed for efficient selections made using the pointer via a mouse, trackpad, or pen and tablet, made in conjunction with a variety of commands for extending and editing selections triggered via keyboard shortcuts. If you're editing with a keyboard and mouse, this mode is designed to let you work quickly by enabling a variety of different selection functions based on clicking different parts of clips.

Selecting Tracks

In order to understand clip selection, you must first understand track selection. The Timeline on the Fairlight page lets you select entire tracks to facilitate the automatic selection of clips that intersect the playhead on those tracks using keyboard shortcuts, the Fairlight Desktop Console, or the Fairlight Editing panel, in Selection and Range Selection modes (described in upcoming sections).

For example, were you to select tracks A2, A3, and A4, then moving the playhead to intersect two clips on those tracks in Selection mode automatically selects them, so they're ready for any operation you want to perform on both clips. To give a few examples, you could now split both clips at the playhead, Cut Head or Tail to the playhead, Delete both clips, or Copy them in preparation for pasting elsewhere.

Additionally, there are times when clicking or dragging on one or more clips with the pointer results in both those clips being selected, along with the tracks on which they sit. For example, selecting clips using the Edit Selection mode will also select the tracks those clips are on.
TIP: Selecting tracks in the Fairlight page is analogous to using the Auto Select controls in the Edit page Timeline, which define which clips on which tracks will be automatically selected whenever you set In and Out points in the Timeline.

If you’re manually selecting tracks using the pointer, there are different ways to do so.

**Methods of selecting and deselecting tracks in the Fairlight page Timeline:**

- **To select a single track:** Click anywhere in the background or on the track number of that track’s header (not on a button). In Range Selection mode you can also click in any unused area of the track itself.

- **To deselect a single track:** Click anywhere in the background or on the track number of a previously selected track’s header (not on a button). In Range Selection mode you can also click in any unused area of the track itself. If multiple tracks are selected, Command-clicking one will remove just that track from the selection.

- **To select multiple tracks:** Command-click in the track header background of every track you want to select. In Range Selection mode you can also Command-click in any unused area of the tracks themselves. Command-clicking an already selected track will deselect it.

- **To select multiple continuous tracks:** Click anywhere in the background or on the track number of a track header, and then drag a bounding box up or down over all other tracks you want to select. In Range Selection mode you can also drag a bounding box over any part of the tracks themselves, while also defining a range in which you want to work.

- **To move the selection to higher or lower tracks:** Press Control-Option-Up Arrow or Down Arrow to move the selection state to the next track higher (Control-Option-Up Arrow) or lower (Control-Option-Down Arrow). If multiple tracks are selected, then the multi-selection will be moved as a block; for example, selecting tracks A2 and A3 and then pressing Control-Option-Down Arrow will result in tracks A3 and A4 being selected.

**Using Selection Mode**

Selection mode uses the position of the playhead to make automatic selections when using the Fairlight Editing console or keyboard shortcuts to make clip selections on selected tracks. However, you can also use this mode in conjunction with the pointer and keyboard shortcuts to make selections in a different style. Selection mode is primarily intended to allow efficient editing of whole clips.

- **If no tracks have been selected:** Clips that intersect the playhead are not selected. You can use the pointer to select one or more clips by clicking, Command-clicking, or dragging a bounding box. Clips you select in this way are highlighted in orange. Making selections in this way is similar to making clip selections in the Timeline of the Edit page.

- **If tracks have been selected:** All clips that intersect the playhead on selected tracks will be automatically highlight selected, but no In and Out points will be set. Clips on de-selected tracks will be ignored. Selecting one or more clips with the pointer (by Command-clicking or dragging a bounding box) creates an orange-highlighted selection.

- **If you set In and Out points:** Some functions will affect ranges of clips between In and Out points on selected tracks. Clips on unselected tracks are ignored.

**To choose Selection mode:**

- Click the Selection tool (the arrow) in the toolbar.
- Choose Trim > Selection Mode.
- Press A.
To automatically select clips using the playhead position in Selection mode:

1. Press A to enter Selection mode.
2. Select one or more tracks with clips you want to select.
3. Move the playhead to intersect those clips.

All clips that intersect the playhead on selected tracks of the Timeline are automatically selected in their entirety. Automatic selections are illuminated brighter to indicate their selection. Intersecting clips on unselected tracks are not selected.

Methods of selecting clips using the pointer in Selection mode:

- Click any clip to select it.
- Command-click multiple clips to select them all at once.
Click anywhere in the background of the Timeline and drag a bounding box over multiple clips.

Using Range Selection Mode

Range Selection mode also uses the position of the playhead to make selections of a partial range of clips in the Timeline when using the Fairlight Editing console or keyboard shortcuts. You can also use this mode in conjunction with the pointer and keyboard shortcuts to make partial selections of clips.

- If no tracks have been selected: Clips that intersect the playhead are not selected. You can use the pointer to click a clip and select it in its entirety along with the track it’s on. You can also use the pointer to drag on one or more clips to select a partial range in preparation for different editing operations. Whenever you make a selection with the pointer, Timeline In and Out points are set to the boundaries of the selection.

- If tracks have been selected: Selected tracks are brightened in the Timeline, and any clip on a selected track that intersects the playhead will be automatically highlighted brighter. Clips on deselected tracks will be ignored. Dragging a crosshairs over one or more clips with the pointer overrides all automatic selections and selects the regions of the clips you drag over, and the tracks they’re on.

- If you set In and Out points: Partial regions of all clips on all selected tracks between the In and Out points will be highlighted brighter. Clips on unselected tracks are ignored. While In and Out points are set, the playhead no longer makes automatic selections; you must set new In and Out points to modify the selection in this mode.

To choose Range Selection mode:
- Click the Range Selection tool (the crosshairs) in the toolbar.
- Choose Trim > Range Selection Mode.
- Press R.

To automatically select clips in Range Selection mode using the playhead position:
1 Press R to enter Range Selection mode.
2 Select whichever tracks have clips you want to select.
3 Move the playhead to intersect those clips.

All clips that intersect the playhead, on the tracks you selected, define a selected range from the beginning of the first selected clip to the end of the last selected clip.
Clips intersecting the playhead on a selected track in Range Selection mode are automatically selected.

To create custom clip ranges using In and Out points in the Timeline:

1. Press R to enter Range Selection mode.
2. Select whichever tracks have clips you want to select.
3. Move the playhead and press the I (Mark In) and O (Mark Out) keys to define a range in the Timeline.

All clip segments that fall within the range of your In and Out points on selected tracks will be selected.
Methods of selecting clips in Range Selection mode via clicking and dragging:

- **To select a single clip:** Click any clip to select both it and the track it's on, and define a range in the Timeline that matches the duration of that clip.

  ![Click to select a single clip as well as the track it's on](image)

- **To select multiple clips:** Command-clicking multiple clips to select them all at once defines a range in the Timeline that matches the total overlapping duration of all clips in the selection, from the beginning of the first selected clip to the end of the last selected clip.

  ![Range selection by Command-clicking multiple clips](image)

- **To drag to select a range within a single clip:** With the Range Selection tool selected, drag anywhere on top of a clip to drag a bounding box over whatever segment of that clip (or of one or more clips) to select both that clip segment and the track it appears on. This is a good way of selecting part of a recording you want to move or delete.
Ranged selection within a clip using a bounding box

- **To drag to select a range within multiple clips:** Click and drag a bounding box over whatever segment of one or more clips you want to select to select both those clip segments and the tracks they appear on. Or, Command-click and drag anywhere on top of any clip to drag a bounding box over whatever region of clips and tracks you like.

Ranged selection across multiple clips using a bounding box

In Range Selection mode, whenever you make a selection, the In and Out point fields update with the range that you've created.
The range fields showing you the In and Out point values that define the current range.

These ranges can be cleared if necessary.

**Methods of clearing In and Out points to clear the current range:**
- Press Option-I to clear the current In point.
- Press Option-O to clear the current Out point.
- Press Option-X to clear both the In and Out points.

**Using Edit Selection Mode**

Edit Selection mode is designed for making efficient pointer-based selections and edits, in conjunction with an assortment of commands for extending and editing selections that can be triggered via customizable keyboard shortcuts. If you’re editing with a mouse and keyboard, this mode is designed to let you work quickly by enabling a variety of different functions based on clicking different parts of each clip in the Timeline.

Additionally, an important aspect of working in Edit Selection mode is that this is the only mode that lets you edit the Timeline during playback, which you can’t do in Selection and Range modes.

- **If no tracks have been selected:** Whenever you make a selection with the hand, Timeline In and Out points are set to the boundaries of the selection. Whenever you make a selection with the crosshairs, Timeline In and Out points are set to the boundaries of the region you dragged. In all cases, the tracks that contain selected clips and regions of clips are also selected.
- **If tracks have been selected:** Any clip on a selected track that intersects the playhead will be automatically highlighted brightly. Clips on de-selected tracks will be ignored. Dragging a crosshairs over one one or more clips with the pointer overrides all automatic selections and selects the regions of the clips you drag over, and the tracks they’re on.
- **If In and Out points have been set:** Clicking the bottom half of clips in the Timeline will select that clip and track, and the In and Out points will change to encompass that clip.

**To choose Range Selection mode:**
- Click the Edit Selection tool (the crosshairs at the bottom of a track) in the toolbar.
- Choose Trim > Edit Selection Mode.
- This mode has no keyboard shortcut at this time.

**To select an entire clip using the Hand tool of the Edit Selection mode:**
- Move the pointer to the bottom half of a clip until a hand cursor appears, and click once to select that clip in its entirety.
Clicking the bottom half of a clip to select that clip in Edit Selection mode

- Use the Hand to Command-click multiple clips to make either contiguous or noncontiguous selections.
- Use the Hand to Shift-click multiple clips to make contiguous selections.

To select a range using the Crosshairs tool of the Edit Selection mode:

- Move the pointer to the top half of a clip until a cross-hairs cursor appears, and drag to select a region of one or more clips. As you drag, the playhead follows the Out point.

Dragging within the top half of a clip to select a region in Edit Selection mode

- Using the crosshairs, you can also Command-click to expand or contract the selected region across one or more clips.
- Using the crosshairs, you can also double-click to select an entire clip.
To select a single frame using the Crosshairs tool of the Edit Selection mode:

– Move the pointer to the top half of a clip until a cross-hairs cursor appears, and click once to place a point selection at the frame you clicked. The playhead also moves to this frame.

![Clicking within the top half of a clip to make a single frame selection](image)

– Using the crosshairs, you can also Command-click clips on higher and lower tracks to add them to the single frame selection, aligned at the same frame. For example, you could do this to split multiple clips at once. One frame selections can be on discontiguous tracks.

![Command-clicking within the top half of multiple clips on multiple tracks to add single frame selections at the same frame](image)

To move a selection using the Hand tool of the Edit Selection mode:

– Once you’ve made a selection of one or more clips or regions using the Hand or Crosshairs tool of the Edit Selection mode, you can move the pointer to the bottom half of any selected clip and drag the selection to another position on the Timeline.

Commands For Editing and Extending the Selection

Once you’ve made one or more selections in the Timeline, there are a series of commands you can use to modify or expand the selection. These commands were designed to be used alongside the Edit Selection mode, but they can be used in any mode.
Editing the Selection

There are six commands for changing the current selection, moving it from one clip or group of clips in the Timeline to another. These commands only move the range of clips/frames that are selected; they do not move the clips themselves. These commands are found within the Timeline contextual menu when you right-click on a clip.

- **Move To Previous/Next Edit**: Moves the current selection to the next clip/edit point to the left or right in the Timeline.
- **Move To Previous/Next Track**: Moves the current selection to the next track up or down in the Timeline.
- **Move to Previous/Next Frame**: Nudges the current selection to the left or right in the Timeline.

Extend Edit Selection

There are four commands for expanding the range of what’s selected in the Timeline, one clip or track at a time. These commands are found within the Timeline contextual menu when you right-click on a clip.

- **To Previous Edit**: Expands the selection to include the previous clip to the left in the Timeline.
- **To Next Edit**: Expands the selection to include the next clip to the right in the Timeline.
- **To Previous Track**: Expands the selection to include the clip in the next track up in the Timeline.
- **To Next Track**: Expands the selection to include the clip in the next track down in the Timeline.

Locking Audio Tracks You Don’t Want to Change

Another step you can take to prepare before performing any kind of editorial operation is to lock tracks with media that you don’t want to be affected by whatever it is you’re about to do. For example, if you have a complex set of music edits on track A3 that you don’t want to be affected by operations that will delete media that overlaps it, you can lock track A3 so those clips remain unaffected.

Clips on locked tracks cannot be moved, deleted, cut, or otherwise affected by editorial operations. Furthermore, parameters of clips on locked tracks cannot be edited in the Inspector. However, clips on locked tracks can be played back and mixed like any other audio clips.

To toggle the lock or unlock state of audio tracks in the Fairlight page, do one of the following:

- Click any track’s lock control to toggle lock on and off.
- Click any track’s lock control and drag over the lock controls of other tracks in the Timeline to quickly lock or unlock several adjacent clips.
- Open the Index and click/drag one or more track lock controls to toggle lock on and off.
Splitting Clips

In many situations you may find yourself splitting audio clips in order to separate multiple rolling takes.

To split one or more clips in either Selection or Range Selection mode:

1. Select each track that has a clip you want to split.
2. Move the playhead to intersect the clips you want to split at the frame where you want the split to happen.
3. Do one of the following:
   a. Choose Timeline > Split Clip or press Command-\ (backslash).
   b. Choose Timeline > Razor or press Command-B.

When you split a clip in the Edit page, a through edit appears to show that you currently have an edit with continuous timecode running from the outgoing to the incoming half. This is called a through edit and is displayed in the Edit page with a dotted line running along its edge so you know that it’s special. The Fairlight page doesn’t display through edits as of the time of this writing.

Linked Clips in the Fairlight Page

Clips can be linked together in the Fairlight page. When multiple clips are linked, Fairlight editing commands treat all linked clips as if they were a single clip. Anything you would do to a single clip is done to all linked clips at once. Selecting one item of a linked clip selects all items. Editing the In point of one item of a linked clip edits them all.

To link two or more clips together:

1. Select all clips you want to link together.
2. Right-click one of the selected clips, and choose Link Clips from the contextual menu.

A link indicator at the bottom left of every clip you’ve just linked shows their new linked status.

Trimming Clips Without Rippling the Timeline

Most basic adjustments in the Fairlight page only affect the selected clip or region of the Timeline. Clips to the right of the adjusted area of the Timeline are generally left alone so as not to inadvertently change sync when you don’t expect it. This section covers the most basic parts of the Fairlight page’s “seven-point editing” paradigm.

Multi-Point Editing Overview

Each clip in the Timeline has several draggable handles and click targets that let you perform different editing tasks using the pointer.

- **In point:** The left edge of the clip can be dragged to resize the beginning of the clip.
- **Out point:** The right edge of the clip can be dragged to resize the end of the clip.
- **Fade In handle:** A handle at the upper left-hand corner of the clip that only appears when the mouse is positioned over that clip, used to fade the audio in by dragging it to the right, or as part of a crossfade between two audio clips. Fades can be reset (eliminated) by double-clicking the fade handle.
– **Fade In curve**: A handle at the center of the Fade In curve that only appears when the curve is exposed, used to adjust the power of the fade in. This handle can be dragged vertically to change the X-Level of the fade, and horizontally to change the X-Point of the fade. Fade curves can be reset by double-clicking the curve handle.

– **Fade Out handle**: A handle at the upper right-hand corner of the clip that only appears when the mouse is positioned over that clip, used to fade the audio out by dragging it to the left, or as part of a crossfade between two audio clips. Fades can be reset (eliminated) by double-clicking the fade handle.

– **Fade Out curve**: A handle at the center of the Fade Out curve that only appears when the curve is exposed, used to adjust the power of the fade out. This handle can be dragged vertically to change the X-Level of the fade, and horizontally to change the X-Point of the fade. Fade curves can be reset by double-clicking the curve handle.

– **Level**: Considered an editorial characteristic, the level of any given audio clip can be adjusted via a level overlay running across each clip. The level of any clip can be reset to the default 0.0 dB by double-clicking the level overlay.

– **Position**: Clicking anywhere within the middle of a clip in Selection or Range mode, or on the bottom of Edit Selection mode, lets you drag that clip either forward or backward in time, or to another track.

### Resizing the In and Out Points of a Clip

Trimming the head or tail of a clip in the Fairlight page means to resize the In or Out point of that clip, making it shorter or longer accordingly.

**To resize the beginning or end of a clip:**

– **To shorten or lengthen clips**: Move the pointer over the beginning or end of a clip, and when it turns into the Resize cursor, drag the In or Out point to the left or right to change the clip's length. As you drag the In or Out point of an audio clip in the Fairlight page, an overlay appears showing the waveform of all available media at the head (if you're dragging the In point) or tail (if you're dragging the Out point) of the clip you're resizing.

![The overlay seen when resizing the In point of an audio clip in the Fairlight page](image)

**To quickly resize the beginning or end of a clip to the very beginning or end of available media:**

– Double-click the In point of the clip to move the In point to the very beginning of that clip's media.

– Double-click the Out point of the clip to move the Out point to the very end of that clip's media.

If you resize a clip's In or Out point to overlap one or more neighboring clips in the Timeline, the overlapping parts of the neighboring clips will be overwritten by the clip you've resized.

### Trim Start and Trim End

The Trim > Trim Start (Shift-`) and Trim End (Shift-`) commands let you move the In or Out point of all clips that intersect the playhead as either a ripple operation (in Trim mode) or a resize operation (in Selection mode). You do not need to make a selection to use Trim Start and Trim End, making these
commands fast to use in the right situation. A classic use of Trim End is when you have several superimposed clips of different lengths that you want to either start or end at the same time.

- Trim Start resizes or ripples (depending on what mode you’re in) all clips that intersect the playhead, so that each clip’s In point is moved to the current playhead position.
- Trim End resizes or ripples intersecting clips so that each intersecting clip’s Out point is moved to the current playhead position.

Clips that don’t intersect the playhead are not affected. Furthermore, you can exclude clips on specific tracks from this operation by locking those tracks.

**Trim to Selection**

The Trim > Trim to Selection (Shift-Command-T) command simultaneously trims the heads and tails outside of a selection of one or more clips so that the selection is all that remains. This command is found within the Timeline contextual menu when you right-click on a clip.

(Left) A selection that includes parts of two clips, (Right) The result of using Trim to Selection to eliminate the heads and tails outside of this selection.

**Moving and Overwriting Clips**

There are a number of ways to move clips in the Timeline. Clips can be moved within a track, changing the timing of that clip's position in the edit or they can be moved up or down to other tracks.

**To move clips in the Timeline, do one of the following:**

- **To move one or more selected clips in the Timeline:** Drag any clip in the Timeline to any other position. If you’re in Edit Selection mode, you must drag using the bottom half of the selection. If you drag a clip to overlap another clip, the clip you’re dragging overwrites the clip you’re moving it over.

- **To nudge one or more selected clips in the Timeline by frame using the keyboard:** Make a selection, then press the Comma key (nudge 1 frame left) or Period key (nudge 1 frame right) to roll the selected edit to the left or right. Shift-Comma and Shift-Period nudges by 5 frames.

- **To move one or more selected clips up or down to other tracks at the same time:** Make a selection, then hold the Shift key down while dragging one of the selected clips up or down in the Timeline to lock their position in time while moving them to other tracks. Or, you can hold the Option key down and press Up or Down Arrow.
Sync Offset Indicator

Audio clips in the Fairlight page display an “out-of-sync” or sync offset indicators when they’re moved out of sync with the video items they’re linked to.

Slipping

Formerly called resyncing, slipping an audio clip keeps that clip in the same place in the Timeline while changing the range of media that appears in that spot. Slip edits do not change the duration of the overall Timeline, and they don’t move the clip’s position relative to the other clips in the Timeline. Slipping simply changes the range of media that clip represents.

**NOTE:** While available in previous versions of Fairlight, slipping is not available at the time of this writing.

Duplicating Clips

The Duplicate Selection command duplicates one or more selected clips, placing the duplicates immediately after the Out point of the selection. If you’re duplicating a region of a clip with tails, or a clip that’s in between other clips, the duplicated selection will overwrite whatever is to the right of the current selection, for the duration of the duplicate.

If you hold the Option key down while dragging a clip in the Timeline, you’ll place a duplicate clip wherever you drop it.
Option-dragging to duplicate a clip in the Timeline

Disabling and Re-Enabling Clips in the Timeline

Sometimes there’s one or more audio clips in the Timeline that you don’t want to play along with the rest of the edited sequence, but you don’t want to remove from the Timeline either, in case you change your mind later. For this reason, it’s possible to disable clips, effectively turning them off without removing them. Previous versions of Fairlight referred to this operation as Mute clip.

Disabled clips appear dimmed in the Timeline. They don’t play back, they’re not rendered, and they’re not output to video. However, their position is preserved in the Timeline, so you can always re-enable them at a later time if you change your mind and decide you want to use them.

Disabled clips appear in the Timeline in gray.

To disable or re-enable one or more selected clips:

– Right-click part of the selection and choose Enable Clip from the contextual menu.
– Choose Clip > Enable Clip.
– Press D.

Deleting Audio Clips and Regions

You can delete any clips or clip regions that are selected, in either Selection or Range Selection modes, by pressing the Delete key, or by right-clicking a clip and choosing Delete Selected from the contextual menu. By default in the Fairlight page, deleting anything leaves a gap. Under the Edit Menu > Ripple Delete you can ripple delete selected clips changing the placement of all of the clips that follow.

Cut, Copy, and Paste

The Fairlight page has a unique copy and paste methodology that takes advantage of the “ghost” overlays that are used for the waveforms of selected audio clips. This method makes it easy to copy and paste clips using keyboard shortcuts and the JKL keys.

Conventional Cut, Copy, and Paste

The typical cut, copy, and paste commands expected of every software application are available in the Fairlight page, but with a unique twist that’s particularly advantageous for users of the Fairlight control surface, or for anyone who uses the JKL transport key shortcuts to move around the Timeline for keyboard-driven editing.
To cut or copy and paste either all or part of a clip:

1. If you’re cutting or copying a whole clip, then choose either the Selection (press A) or Range Selection (press R) mode. If you’re cutting or copying part of a clip, then make sure you’re in Range Selection mode (press R).

2. To use the playhead to make a clip selection, select the track that contains the clip you want to copy or cut. If one or more tracks are already selected, you can use the Control-Option-Up or Down Arrow key shortcuts to move the track selection state up or down to the tracks with the clip you want to cut or copy.

3. Do one of the following:
   a. To cut or copy a whole clip, move the playhead so that it intersects the clip you want to cut or copy. If the playhead intersects a clip on a selected track, that clip should become selected. You should note that even if you use the mouse to select a clip without selecting a track first, you should still move the playhead to intersect the clip you’re copying or pasting, as this sets up an important reference point for the operation.
   b. To cut or copy a segment of a clip, move the playhead so that it intersects the clip you want to cut or copy. If the playhead intersects a clip on a selected track, that clip should become selected. Then, using JKL and the I (In) and O (Out) keys, mark a range in the Timeline that includes the segment of the clip you want. That segment should appear highlighted as a result.
Making sure the playhead is over the section of the waveform that you want to use as the frame to move the clip by, press Command-X to cut or Command-C to copy that clip (you can also right-click a clip and choose Copy or Cut). That clip will immediately become highlighted.

At this point, there are two things you can do to position the cut or copied clip to the position in the Timeline at which you want to paste it:

a. Moving the playhead will now also move the clip you cut or copied, shown as a ghost clip with waveform that’s “attached” to the playhead at the frame you chose. Whether you drag the playhead with your mouse or use JKL to move the playhead through the Timeline, the cut or copied clip will move along with it, so that moving the playhead repositions the cut or copied clip on that track.

b. If you want to move the cut or copied clip to another track, use the Control-Option-Up or Down Arrow key shortcuts to change the selected track; the ghost clip will move along with change in track selection.
This way, you can use the playhead to align the ghost waveform with other audio clips surrounding it in preparation for pasting it.

6. When the clip is positioned where you want it, press Command-V to paste the clip at the position you’ve chosen (you can also right-click a track and choose Paste from the contextual menu). The clip becomes solid, and you’re finished.

Using this method of cutting and pasting makes it quick to cut or copy clips using only keyboard commands, with the clip’s ghost overlay making it easy to precisely align the clip you’re pasting to fit exactly where you need it to, perfectly in sync.

**Using the Cut/Copy Head and Tail Commands**

Four additional commands make it easy to cut or copy portions of one or more clips that intersect the playhead, either from the In point to the current position of the playhead (the Head), or from the current position of the playhead to the Out point (the Tail).

**To cut or copy the head or tail of a clip, and paste the result:**

1. Using these commands, there’s no need to make a partial selection, so you can use either the Selection (press A) or Range Selection (press T) modes.

2. Select the track that contains the clip you want to copy or cut. If one or more tracks are already selected, you can use the Control-Option-Up or Down Arrow key shortcuts to move the track selection state up or down to the tracks with the clip you want to cut or copy.

3. Move the playhead so that it intersects the clip you want to cut or copy at the frame you want to define, either the end of the head or the beginning of the tail. If the playhead intersects a clip on a selected track, that clip should automatically become selected. You should note that even if you use the mouse to select a clip without selecting a track first, you should still move the playhead to intersect the clip you’re copying or pasting, as this sets up an important reference point for the operation.

4. Choose Edit > Cut/Copy Head/Tail to cut or copy the portion of the selected clip you want to paste. That portion of the clip will immediately become highlighted.

5. At this point, there are two things you can do to position the cut or copied head or tail of the clip to the position in the Timeline at which you want to paste it:
a. Moving the playhead will now also move the clip you cut or copied, shown as a ghost clip with waveform that’s “attached” to the playhead at the frame you chose. Whether you drag the playhead with your mouse or use JKL to move the playhead through the Timeline, the cut or copied clip will move along with it so that moving the playhead repositions the cut or copied clip on that track.

b. If you want to move the cut or copied clip to another track, use the Control-Option-Up or Down Arrow key shortcuts to change the selected track; the ghost clip will move along with change in track selection.

This way, you can use the playhead to align the ghost waveform with other audio clips surrounding it in preparation for pasting it.

6 When the clip is positioned where you want it, press Command-V to paste the clip at the position you’ve chosen (you can also right-click a track and choose Paste from the contextual menu). The clip becomes solid, and you’re finished.

Paste and Remove Attributes

The Fairlight page has Paste Attributes and Remove Attributes commands that allow for the copying and resetting of audio parameters and effects, similar to the same commands on the Edit page.

Copying and Pasting Clip Attributes

For clips, this works as simply as copying a clip, then selecting one or more audio clips and right-clicking another clip and choosing Paste Attributes from the contextual menu. A dialog appears letting you choose which audio attributes you want to paste before clicking Apply.

Copying and Pasting Track Attributes

For tracks, it works a little differently. Right-click on a track header and choose Copy Attributes to copy all track settings and effects. Then, select one or more other track headers, right-click the selection, and choose Paste Attributes. A dialog appears letting you choose which track attributes you want to paste before clicking Apply.
Removing Attributes

For either clips or tracks, you can right-click and choose Remove Attributes to open a dialog with which to choose which attributes you want to reset to their default settings.

Audio Clip Layering

Audio layering is a special audio editing mode that lets you superimpose multiple audio clips in the same track, with audio clips edited into the top layers muting overlapping sections of audio clips appearing on lower layers. With audio layering enabled, superimposed audio clips are treated similarly to superimposed video clips that have opacity set to 100%, with clips on top obscuring (or muting) clips underneath.

Audio layering is incredibly useful for any situation where you’re combining segments of multiple takes together to create a single voiceover, audio vocal track, or dramatic performance, as you can choose which segments to use via their superimposed position in the stack of clips appearing in that track, while at the same time you’re preserving the other takes underneath in case you might want them later.

**TIP:** Track layering can be used on the Edit page as well.

**To enable audio layering:**
- Choose Timeline > Layered Audio Editing so that a check mark appears by the command. All overlapping audio will be layered instead of overwritten from that point forward.

**To view audio layering:**
1. Choose View > Show Audio Track Layers to reveal track layers for each audio track (and each lane within a given audio track) in the Timeline. When layering is on, space appears at the top of each track in the Timeline which provides a region into which you can edit layered audio clips.
2. To edit an audio clip or segment as a layer within a particular audio track, drag it from elsewhere in the Timeline or from the Media Pool, and drop it into the empty area above whatever audio is already in that track.
3 Edit the different superimposed layers of audio such that the segments of each take that you like are on top. Only the topmost clip segments will be audible. Audio segments that overlap underneath are silent. To put another layer on top, drag it from its current position to the empty area at the top of the track.

4 When you’re finished editing clips in track layers, choose View > Show Audio Track Layers again to hide the individual layers, so that only the topmost clips appear as a flat sequence in each track and lane.

Audio Compound Clips

DaVinci Resolve supports audio compound clips, which are created just like any other compound clip, by selecting multiple audio clips, right-clicking one of them, and choosing New Compound Clip. Alternately, compound clips with video clips may now contain multiple audio items as well.

When compound clips containing audio are opened in the Edit or Fairlight pages by right-clicking an audio compound clip and choosing Open in Timeline, breadcrumb controls appear beneath the Timeline that let you exit the compound clip and get back to the master Timeline.
Audio Crossfades

You can add Cross Fade transitions to any edit point between two audio clips that have enough handles similarly to how you add video transitions, by dragging and dropping from the Effects Library, by right-clicking an edit and choosing an option from the contextual menu, or by selecting an audio edit point and choosing Timeline > Add Audio Only Transition (Shift-T).

Cross Fade transitions are a quick and easy way to fade the volume of the outgoing clip down while simultaneously fading the volume of the incoming clip up, letting you create a smooth aural transition between two audio clips.

An audio Cross Fade transition applied between two clips

You can double-click a Cross Fade transition to open it into the Inspector, revealing the following parameters:

- **Duration**: The duration of the transition, shown in both seconds and frames.
- **Alignment**: A drop-down that lets you choose the transition’s position relative to the edit point it’s applied to. Your choices are “End on Edit,” “Center on Edit,” and “Begin on Edit.”
- **Transition style**: You can choose –3dB, 0dB, or +3dB to set both the Fade In and Fade Out levels to the same value. For more information on what these levels mean, see the following parameter.
- **Fade In/Fade Out levels**: There are three options that affect the incoming and outgoing halves of the Cross Fade effect independently. 0dB applies a linear fade (this is the default). +3dB applies a boosted curve; when applied to both Fade In and Fade Out, this can compensate for diminished levels in the middle of a Cross Fade. –3dB applies an attenuating curve, which deliberately lowers the level of the Cross Fade.

Crossfades can be created and edited on both the Edit and Fairlight pages.

Fades and Crossfades

Part of audio editing in the Fairlight page is the use of fades and crossfades. This section shows you how to create these effects for smoothly segueing from one audio clip to another.

Using Fades

Like the Edit page, each audio clip has fader handles that appear at the upper right and left corners of a clip you’re hovering the pointer over.

Fader handles appear when you hover the pointer over a clip
Pulling these handles out creates a fade effect with a duration equal to the length you extended the handle.

Creating a fade effect by pulling out one of the fader handles

Once you’ve created a fade effect, you can adjust the curve of the fade by dragging the handle that appears right on top of the fader curve. Dragging the handle up and down affects the angle of the curve, and dragging the handle left and right affects the shape of the curve. In this way, you can create all manner of fade effects.

Adjusting the curve of the fade

**Batch Fade and Crossfade Editor in the Fairlight Page**

Multiple fades are available to multiple clips with multiple tracks selected, significantly increasing fade functionality. The Batch Fades window has fade shapes for Fade In, Cross Fade, and Fade Out. The Fade Length is user definable by frame for each of these fade types, and there is an option to overwrite existing fades on the highlighted clips.

All of the settings in the Batch Fades window
There are six options per Fade type for precise usage. When adding Fades between sources, it's important to determine the shape so that only the desired media is included in the fade. The curves indicate the ramping slopes of the fade.

Each box has similar controls for affecting the individual Fade type.

1. Next to the Fade type name is the on/off toggle.
2. There are six Fade curves to create the precise fade needed.
3. A Length box determines how many frames the fade will extend,
4. A click box to overwrite any previous fades, if needed.

The Crossfade box has three additional controls.

1. Equal Power maintains the signal level through the fade.
2. Equal Gain is used when crossfading media that could phase when combined. For instance, if a music cue is crossfaded at the mid-point of the fade, there could be a jump in level or added phasing issues. Using this option maintains the gain across the fade for that type of media.
3. Unlinked allows for a different curve type on either side of the crossfade.

This window will retain the settings that were last made so once a series of Fade types have been chosen, then Batch Fades can be made without opening this window and can be accessed via the Fairlight menu with a single click across highlighted regions. The Apply Batch Fades in the Fairlight menu are applied with the settings made in the Batch Fades window.

This graphic shows highlighted clips and tracks ready to have Batch Fades applied.
Tracks and clips highlighted for Batch Fades

The graphic below shows how the Batch Fades are applied. Clips that are not connected have Fade In and Fade Out applied. Clips that are connected have Crossfades applied. The Batch Fades window determines each of the Fade parameters and then applies them to all of the selected clips. In this example, the Overwrite box was unchecked. Compare the fades that were already there and see that they retain their original Fade length and shape.

All of the highlighted clips have been faded according to the Batch Fades window.

**NOTE:** If the media is too short, a dialog box will alert you that there are insufficient handles and that the fade could not be created. You can then choose to trim clips, skip clips, or cancel the Batch Fade. If you cancel, you can then alter the settings to better suit the media.
Fade In and Out to Playhead

A pair of commands in the Trim menu let you move the playhead over a clip, and use the playhead position to “Fade In to Playhead” or “Fade Out to Playhead.” These commands work in both the Edit and Fairlight pages.

(Left) Placing the playhead where you want a fade in to end. (Right) Using Fade In to Playhead

Creating Crossfades With Overlapping Fades

While a fade gradually fades a single track of audio up or down, a crossfade fades two overlapping clips at the same time, fading one clip up and another clip down, for the aural equivalent of a cross dissolve. There are currently two ways of creating a crossfade in the Fairlight page. Both depend on clip layering to allow you to have overlapping fades over overlapping clips.

To create a crossfade by overlapping two clips together:

1. Add a fade out to the end of one clip, and a fade in to the beginning of another clip. By default, all fades you add in this way are linear, although you can adjust them to whatever gain you want.

Adding fades to adjacent clips

2. Drag the first clip to overlap the second clip by the length of the fade you’ve created.

Dragging the clips to overlap, the overlapping parts will be preserved via clip layering

3. Drop the clip. The overlapping fades will both be preserved thanks to clip layering, and a crossfade will appear in the Timeline.
To create a crossfade over two clips that are already layered:
– Drag a fader handle at the beginning or end of a clip that’s layered, and a crossfade will automatically appear.

Using Crossfades From the Edit Page
You can also add crossfades in the Edit page, but they appear in the Fairlight page as transitions in the Edit page style.

Finding Clips in the Media Pool
You can right-click any clip in the Timeline and choose Find in Media Pool to automatically select that clip in the Media Pool, for instances where you might want to edit another copy of that clip somewhere else in the Timeline, or re-edit another segment from that clip into the same area.

NOTE: Automation Follows Edit when clips with embedded automation are moved or pasted from the Timeline. When clips with automation are instead pulled from the Media Pool, they are in their default state with no automation attached.
Changing Clip Color in the Timeline

You can right-click one or more selected clips in the Timeline to change the clip color, to be more organized. For example, you might set production audio clips containing dialog from different actors to different colors, or you could set clips with dialog, music, and effects to different colors in order to easily differentiate each clip’s purpose.

Editing Audio Clips in External Editors

While working in the Fairlight page, you have the ability to process an audio file using a third-party application if necessary, in the event you need to use another application’s capabilities to create an effect or solve an issue that can’t be accomplished in the Fairlight page itself. To do this, you must first add one or more applications to the External Audio Process list in the Audio Plug-ins panel of the System Preferences.

To add an external audio process:

1. Open the System tab of the DaVinci Preferences, and select the Audio Plugins panel.
2. Click the Add button in the “Setup External Audio Processes” section.
3. To give the audio process a different name, double click in the Name column and type a new name.
4. Double-click in the empty Path column for the new process, and choose an application to assign to that process from the dialog.
5. Choose the type of process you want it to be from the drop-down menu in the Type column.

Once you have one or more external audio applications configured in Preferences, you can use them to process any audio clip in the Fairlight page by right-clicking an audio clip and choosing the application you want to use from the External Audio Process submenu of the contextual menu.

When you do this, a duplicate of the audio clip media is copied (bounced) to the directory location specified by the “Save clips to” field of the Capture and Playback panel of the Project Settings. At that point, the external application is either opened or launched as a command from the command line (depending on how the external application has been configured in Preferences).

Once the bounced audio is opened in the external application, you can process it however you need to and bake in any changes made by saving/rendering/outputting and overwriting the original copied audio media file. DaVinci Resolve detects when changes have been made, and the altered result is automatically reimported as an additional audio layer on top of the original clip in the Timeline.

The way an audio application is configured in the DaVinci System Preferences dictates how the bounced audio file is passed to the external program. There are three choices:
– **Command Line:** As a command line parameter, if your audio application is able to be run from the Terminal.

– **Clipboard:** By placing the path to the bounced file in the clipboard, so you can paste it into the application which has been automatically launched, or import it via a File > Open dialog.

– **Reveal:** By revealing the bounced copy in the file manager of your workstation, so you can drag and drop it onto the application which has been automatically launched.

**Bouncing Audio Clips to External Files**

For any workflow where you need to write clips from the Timeline to external files without whatever levels, EQ, dynamics, filters, or other filters have been applied in the Fairlight page, you can use the Bounce Clips to Files command.

**To bounce clips to external files:**

1. Select one or more clips in the Timeline.
2. Right-click one of the selected files and choose Bounce Clips to Files from the contextual menu.
3. When the Bounce Clip to File dialog appears, do the following:
   a. Click Browse to choose a location to save the bounced audio files.
   b. (Optional) Enter a tag and one of the various Name options.
   c. Choose a Format and Bit Depth for the bounced clips.
4. Click Bounce.

   The selected audio files are written to the location you chose.

**Multi-Channel Bouncing**

Audio clips linked in the Timeline can be bounced to a multi-channel file.

**To link clips:**

– Right-click the files in the Timeline and choose Link Clips from the contextual menu.

– Right-click the linked clips and choose Bounce to disk from the contextual menu, making sure to set the bounce to multi-channel.

The Bounce to Disk dialog box allows for choosing Bit Depth, File Name, Tag, and Folder destination.
The Bounce Clip to File dialog box offers naming, destination, and user-defined bit depth.

Sample Editing

You can zoom quite far into audio clips on the Fairlight page timeline, until you see the individual samples that comprise the audio waveform of each clip. Samples are represented by control points once you’ve zoomed in far enough.

When you zoom in far enough, you can see the individual samples of an audio clip as control points.

You can non-destructively edit these control points to eliminate clicks and pops, and to effect other fixes to problem audio clips.

Methods of editing audio samples:

– **To see the editable audio samples:** Zoom all the way into an audio clip until you see the sample control points, using either Command-Plus or Command-Minus, the scroll wheel of your pointing device, or by holding down the ZOOM button of your Fairlight editing panel and turning the JOG/EDITING wheel.

– **To edit a single audio sample:** Click and drag that audio sample up or down to change its height.

– **To edit a section of samples:** Click and drag horizontally left or right across the samples you want to edit to “redraw” the waveform any way you’d like.

– **To reset all edited samples to their original state:** Right-click an audio clip with edited samples, and choose Reset Edited Samples from the contextual menu.

Black points show the previous levels when samples have been edited in a clip.

Sample editing can be undone, just like any other editing procedure, as the edited sample points are stored non-destructively within the DaVinci Resolve project.
Waveform Zero Crossing Indicator

Waveforms have a zero crossing indicator line. Since a waveform is an image representation of sound continually moving positive to negative, the zero crossing point is the level at which that fluctuation occurs. When zooming into a waveform at the sample level, the waveform will display the zero crossing line to enable precise editing.

The zero crossing is a useful feature when editing audio, since clean edits are made at the zero crossing to avoid inducing clicks or pops. A crossfade between two audio clips automatically brings both sides of the fade to the zero crossing.

The center line in the waveform indicator is the zero crossing.
Each audio clip in a track has individual settings that are specific to that clip, which can be adjusted and animated in the Inspector. This makes it easy to adjust the levels and EQ of several clips to match one another, while reserving the track level for your overall mix. An additional set of clip-specific pitch controls make it easy to make small pitch adjustments, either static or keyframed, where necessary.

This chapter describes how to use these clip-specific controls.

Contents

Making Adjustments in the Inspector 3248
Using the Inspector 3248
Audio Settings in the Inspector 3249
Adjusting Multiple Clips at the Same Time 3250
Animated Inspector Adjustments 3250
Paste and Remove Attributes 3252
Setting Clip Volume 3252
Adjusting Volume in the Inspector 3252
Adjusting Volume in the Timeline 3252
Adding and Adjusting Volume Keyframes in the Timeline 3253
Normalize Audio Levels Command 3254
Volume 3255
Pan 3255
Pitch Controls

Speed Change Controls

Equalizer Controls

Master EQ Controls

Graphical EQ Controls

Bands 1 and 4

Bands 2 and 3

Paste and Remove Attributes for Clips and Tracks

Making Adjustments in the Inspector

Clip-specific audio parameters like Volume, Pan, Pitch, and Equalization can be adjusted and animated in the Inspector. This section walks you through how this works.

Using the Inspector

Audio clips in the Fairlight page expose similar controls to those found in the Audio Inspector Panel of the Edit page. Additionally, the Inspector will display controls for audio plug-ins that you apply to clips as well. All parameters are organized into groups, with a title bar providing the name of that group, along with other controls that let you control all parameters within that group at the same time.

These controls include:

- **Enable button**: A toggle control to the left of the parameter group's name lets you disable and re-enable every parameter within that group at once. Orange means that track's enabled. Gray is disabled.

- **Parameter group title bar**: Double-clicking the title bar of any group of parameters collapses or opens them. Even more exciting than that, Option-double-clicking the title bar of one parameter group collapses or opens all parameter groups at once.
– **Keyframe and Next/Previous Keyframe buttons:** This button lets you add or remove keyframes at the position of the playhead to or from every single parameter within the group. When the button is highlighted orange, a keyframe is at the current position of the playhead. When it’s dark gray, there is no keyframe. Left and right arrow buttons let you jump the playhead from keyframe to keyframe for further adjustment.

– **Reset button:** Lets you reset all parameters within that group to their default settings.

### Audio Settings in the Inspector

Each selected clip and each selected Main or Bus channel strip in the Mixer exposes some audio-specific parameters in the Inspector Panel tabs.

#### The Audio Tab in the Inspector

**These are the options in the Audio tab:**

– **Volume:** Each clip has a single volume control, which corresponds to the volume overlay over each audio clip.

– **Pan:** (Only exposed for clips) A simple Pan slider that controls stereo panning.

– **Pitch:** (Only exposed for clips) Each clip has two pitch controls for altering clip pitch without altering clip speed. You can control pitch in Semi Tones and Cents.

– **Speed Change:** Any adjustments made using Elastic Wave to the clip is found here.

– **Equalizer:** (Only exposed for clips) Each clip also has a four-band EQ, complete with low-pass, high-pass, and parametric settings for fine tuning and problem-solving audio issues at the clip level.

![The Audio tab of the Inspector](image)

#### The Effects Tab in the Inspector

If you’ve applied any Fairlight FX, VST plug-ins, or Audio Unit plug-ins, those controls will appear in the Effects tab the Inspector. For more information, see Chapter 176, “Audio Effects.”

Additionally, when you apply other audio plug-ins from the Audio FX panel of the Effects Library, additional parameters and controls are exposed.

![De-Hummer controls in the Effects tab of the Inspector](image)
The Transition Tab in the Inspector

If you've applied any Transitions between clips, you can make adjustments in the Transition tab.

Adjusting Multiple Clips at the Same Time

There's an easy way to make adjustments to the Inspector parameters of multiple clips at the same time, without needing to use Paste Attributes (described later in this chapter). All you need to do is simultaneously select every clip you want to alter, and then modify the parameter in the Inspector that you want to change. As a result, every selected clip will be adjusted by the same amount. This works for compositing effects, transforms, text parameters, filters, and audio settings, just about anything that can be simultaneously exposed in the Inspector for multiple selected clips.

When you select multiple clips, the Inspector will display “Multiple Clips” as the title. If each of the selected clips have different values in the parameter you’re adjusting, that parameter will have two dashes in the value field. There are two ways you can make adjustments to multiple clips:

– If you want to make a relative adjustment to all selected clips while keeping their original offsets from one another, then drag the virtual slider in the parameter field which will display a + or – before however many units your adjustment is.

– However, if you want to set all selected clips to the same value, you can double-click in the number field, type the value, and press Return.

Animated Inspector Adjustments

Keyframing in the Edit page works slightly differently than when using the Keyframe Editor in the Color page. Most simple keyframing tasks can be performed in the Inspector using three buttons that appear to the right of any parameter that’s capable of being keyframed. It takes two keyframes at minimum to create an animated effect.
Methods of keyframing parameters in the Inspector:

- **To add a keyframe:** Select a clip, open the Inspector, then move the Timeline playhead to the frame where you want to place a keyframe, and click the Keyframe button next to the parameter of the Inspector you want to animate. Once you’ve added at least one keyframe to a parameter, all other adjustments you make to parameters in the Inspector, or using the onscreen Transform/Crop controls in the Timeline Viewer, add new keyframes automatically if the playhead is at another frame.

- **To move the playhead to the next or previous keyframe:** Click the small left- or right-hand arrow to either side of a parameter’s keyframe control to jump the playhead to the next or previous keyframe. You can also press Right-Bracket ( ] ) and Left-Bracket ( [ ) to go from keyframe to keyframe.

- **To edit an existing keyframe of a parameter:** Move the playhead to be on top of the keyframe you want to edit, and then change that parameter, either in the Inspector, or using the onscreen controls of the Timeline Viewer.

Methods of changing keyframe interpolation in the Inspector:

- **To change a keyframe to Ease In or Ease Out:** Eased keyframes create animated changes that begin slowly and accelerate to full speed, or slow down gradually to decelerate to a stop. This only works when you have two or more keyframes creating an animated effect. Move the playhead to a frame with a keyframe using the next/previous keyframe controls, then right-click the orange keyframe button and choose Ease In, Ease Out, or Ease In and Out, depending on which keyframe you’re editing and the effect you want to create.

- **To change a keyframe to Linear:** Move the playhead to a frame with a keyframe using the next/previous keyframe controls, then right-click the orange keyframe button and choose Linear.

Methods of deleting keyframes and disabling keyframed effects:

- **To delete a single keyframe:** Open the Inspector, move the Timeline playhead to a frame with a keyframe, and click the orange Keyframe button in the Inspector to delete it.

- **To delete all keyframes for one parameter:** Click the reset button to the right of a parameter’s keyframe control in the Inspector.

- **To delete all keyframes in a group of parameters in the Inspector:** Click the reset button to the right of a parameter group’s title bar in the Inspector.

- **To disable or enable a single parameter’s keyframed effect:** In the Timeline, click the toggle control at the left of a parameter’s keyframe track. Orange means that track’s enabled. Gray is disabled.

- **To disable or enable a group of parameters in the Inspector:** Click the toggle control at the left of a parameter group’s title bar in the Inspector. Orange means that group is enabled. Gray is disabled.
Paste and Remove Attributes

The Fairlight page has Paste Attributes and Remove Attributes commands that allow for the copying and resetting of audio Inspector parameters and effects, similar to the same commands on the Edit page. For more information on how to do this, see Chapter 172, “Editing Basics in the Fairlight Page.”

Setting Clip Volume

Each audio clip, or audio item in the case of audio clips with linked audio on multiple tracks, has its own Volume level. This means that audio clips with multiple channels share a common Volume setting. There are several ways you can adjust these levels simply.

Adjusting Volume in the Inspector

Each clip has individual Volume parameters that are accessible in the Audio panel of the Inspector when one or more audio clips are selected.

Selecting an audio clip in the Timeline and adjusting its Volume only alters the volume levels of that clip, which lets you adjust basic levels for individual clips in your program. The Volume control affects every channel within that clip simultaneously.

If you select multiple clips in the Timeline, then adjusting the Volume or Pan sliders or virtual sliders for all of them simultaneously will make a relative adjustment to all of the clips, preserving their offsets from one another. If you want to set all clips to the same level, then making a numeric adjustment will set all selected clips to the same absolute level.

Adjusting Volume in the Timeline

Each clip (or item) of audio in the Timeline has a Volume overlay that lets you set that clip’s gain level by simply dragging it up or down with the pointer. This overlay corresponds to the Volume parameter in the Inspector.
Additionally, you can click any clip’s Audio Curve Editor button, at the bottom right-hand corner of each audio clip, to open an audio-specific Curve Editor with which you can keyframe not just volume, but pan, and the parameters of any audio filters you might have applied to that clip.

**NOTE:** Under the Fairlight menu > View Clip Info Display, you can show each clip’s gain information by checking the Volume box. This is a handy way to quickly see all of the relative gains of clips in the Timeline.

Adding and Adjusting Volume Keyframes in the Timeline

Mixing audio by adding and adjusting individual keyframes can be a fast and effective way of balancing clip levels with one another and of fixing clip-specific dynamic level problems. When manually editing any audio parameter curve, you can use the following procedures.

**Methods of adjusting the Volume curve using the pointer:**

- **To adjust any curve segment:** Position the pointer over the overall segment for clips with no keyframes, or position it between any two keyframes, directly on top of the curve segment you want to raise or lower. When the move cursor is displayed, click and drag up to raise the Volume, or down to reduce the Volume.

- **To add keyframes to the level curve:** Hold the Option key down and click the curve to place a keyframe at that frame. You must add at least two keyframes to create an automated change in Volume.

- **To adjust a keyframe in any direction:** Move the pointer over a keyframe so that the four-way cursor appears, and then click and drag up or down to change the Volume, or side to side to change its timing.

- **To adjust a keyframe in only one direction:** Move the pointer over a keyframe so that the four-way cursor appears, and then click and drag in the intended direction of adjustment, either vertically to change the volume of the clip at that frame, or horizontally to move the keyframe to a different point in time. Once you start dragging a keyframe into a particular direction, keyframe movement is constrained in that direction until you release that keyframe.

- **To select one or more keyframes:** Click any keyframe to select it.
To select multiple discontiguous keyframes: Command-click all keyframes you want to select, whether they’re next to one another or not.

To select multiple contiguous keyframes: Click the first keyframe you want to select, and then shift-click the last keyframe you want to select, and all keyframes between will also be selected.

Normalize Audio Levels Command

The Normalize Audio Levels command automatically adjusts the level of clips to a specific target level, and you can choose the method used to analyze each audio clip’s levels to determine how to normalize each clip’s volume. Options include a variety of loudness normalization algorithms specific to various international standards, which are useful for balancing the perceived overall loudness of several clips to one another, regardless of transient levels throughout each clip. You can also do Peak normalization, with options for both Sample Peak and True Peak.

The various loudness options are designed to analyze an audio signal based on its perceived loudness to the listener, which results in a more accurate automatic balancing of different clips’ audio levels to one another, regardless of transient peaks occurring throughout different clips.

The target peak meter now uses the BS.1774 standard for measuring maximum “true peak,” which means that this meter is capable of measuring “inter-sample peaks,” rather than only the peaks at each sample of a waveform. However, you still have the option to measure Sample Peak, which is the previous method of measuring the actual peak of the samples in a media file.

The change made by the Normalize Audio Volume command is only a volume adjustment; no dynamics are applied, so the result of using this command is that the loudest parts of each selected clip are going to match one another at the target level. This command is also available in the Fairlight page.

To normalize one or more selected audio clips:

1. Right-click one of the selected clips and choose Normalize Audio Levels. The Normalize Audio Level dialog appears.

2. Choose the Normalization Mode you want to use. You can choose among a variety of standardized loudness measurement algorithms, or Sample Peak, or True Peak.

3. Choose the reference level that you want to set the peak volume of the selected clips to match, in dBFS.

4. Choose how you want to set the level of multiple selected clips:
   - When Set Level is set to Relative, all selected clips are treated as if they’re one clip, so that the highest peak level of all selected clips is used to define the adjustment, and the volume of all selected clips is adjusted by the same amount. This is good if you have a series of clips, such as a dialog recording, where the levels are consistent with one another, and you want to normalize all of them together.
When Set Level is set to Independent, the peak level of each clip is used to define the adjustment to that clip, so that the volume of every selected clip is adjusted by an amount specific to that clip. The end result may be a set of very different volume adjustments intended to make the peak levels of each audio clip match one another. This is good if, for example, you’re trying to balance a series of different sound effects with one another that have very different starting levels.

For more information about loudness normalization, see Chapter 178, “Audio Meters and Audio Monitoring.”

**Volume**

Each audio clip in the Timeline has a simple Volume control that lets you adjust the gain of that clip.

![Volume Control in the Inspector](image)

**Pan**

Each audio clip in the Timeline has a simple stereo Pan control that lets you pan that clip. While most professional mixes will restrict panning to the more robust panner found in the Fairlight page Mixer, this simple clip-based Pan control is useful for editors of visuals working in the Edit page to quickly create simple panning effects to aid in a craft edit. Dragging the slider lets you pan audio left to right. This control is centered at 0 by default.

![Pan Control in the Inspector](image)

**Pitch Controls**

Each audio clip in the Timeline has Pitch controls that let you alter the pitch of a clip without changing the speed. Two sliders let you adjust clip pitch in Semi Tones (large adjustments, a twelfth of an octave) and Cents (fine adjustments, 100th of an octave).

![Pitch control in the Inspector](image)
Speed Change Controls

Each audio clip in the Timeline has Speed Change controls that let you alter the speed of the clip. It has the option to have the clip’s pitch follow the adjusted speed change or maintain the original speed’s pitch.

![Speed Change control in the Inspector](image)

The Speed Change window has the following overall controls:

- **Enable button**: Turns the overall Speed Change effect off and on, without resetting the controls.
- **Reset button**: Resets all controls of the Speed Change window to their defaults.
- **Direction**: The Right Arrow maintains the forward direction of the waveform, the Left Arrow reverses the direction of the waveform, and the Snowflake icon creates a freeze frame.
- **Speed %**: A flywheel control to adjust the speed by a percentage plus or minus 100%.
- **Frames Per Second**: A flywheel control that syncs with the Speed % control showing the FPS relative to the speed change.
- **Duration**: Indicates the new timing of the clip.
- **Ripple Sequence**: When checked this moves all the media after the action to ripple edit to the new duration.
- **Pitch Correction**: When checked this maintains the original pitch of the clips when speed changed. When unchecked the audio will speed up or slow down with the speed adjustment. The slower the speed change, the lower the pitch; the higher the speed change, the higher the pitch.

**NOTE**: When in the Speed Change controls, do not use the freeze frame option. This will negatively affect the selected audio file.

Equalizer Controls

Each audio clip in the timeline has a four-band equalizer that has both graphical and numeric controls for boosting or attenuating different ranges of frequencies within that clip, before it even gets to the EQ built into the mixer. Each band has controls for the filter type (Bell, Lo-Shelf, Hi-Shelf, Notch), Frequency, Gain, and Q-factor (sharpness of the band), with the available controls for each band of EQ changing depending on the filter type.

When a channel strip’s EQ is enabled, the equalization curve that’s being applied is displayed in the Mixer. A channel strip’s EQ settings affect all the clips on that track, so you must open the EQ window to make those modifications.
Master EQ Controls

The Equalizer window has the following overall controls:

– **Enable button**: Turns the overall EQ effect off and on, without resetting the controls.

– **Reset button**: Resets all controls of the EQ window to their defaults.

Graphical EQ Controls

A graph at the top shows a curve with handles that correspond to each of the enabled EQ bands listed below. You can drag any numbered handle to boost or attenuate the range of frequencies governed by that band, using whatever type of equalization that band has been set to.

Bands 1 and 4

The outer two sets of band controls let you make high-pass and low-pass adjustments, if necessary.

– **Band enable button**: Turns each band of EQ on and off.

– **Band filter type**: Bands 1 and 4 can be switched among six specific filtering options for processing the lowest or highest frequencies in the signal. These include (from top to bottom) Hi-Shelf, Hi-Pass, Bell, Notch, Lo-Pass, and Lo-Shelf. Bands 2 and 3 can be switched among Lo-Shelf, Bell, Notch, and Hi-Shelf.
– **Freq:** Adjusts the center frequency of the EQ adjustment.
– **Gain:** Adjusts the amount by which the affected frequencies are affected. Negative values attenuate those frequencies, while positive values boost those frequencies.

### Bands 2 and 3
The middle two sets of band controls let you make a wide variety of equalization adjustments.

– **Band enable button:** Turns each band of EQ on and off.
– **Band filter type:** Bands 2–5 can be switched among four different filtering options (from top to bottom): Lo-Shelf, Bell, Notch, and Hi-Shelf.
– **Frequency:** Adjusts the center frequency of the EQ adjustment.
– **Gain:** Adjusts the amount by which the affected frequencies are affected. Negative values attenuate those frequencies, while positive values boost those frequencies.
– **Q Factor:** Adjusts the width of affected frequencies. Lower values include a wider range of frequencies; higher values include a narrower range of frequencies.

**NOTE:** This may seem obvious, but not all parameters are available for every curve type. For instance, a Bell curve filter has Frequency, Gain, and Q adjustments, but a Lo-Pass or Hi-Pass filter will only have Frequency available to adjust.

### Paste and Remove Attributes for Clips and Tracks
The Fairlight page has Paste Attributes and Remove Attributes commands that allow for the copying and resetting of audio parameters and effects, similar to the same commands on the Edit page.

The Paste Attributes dialog box gives you three types of attributes to choose from. Volume will paste the copied attributes to the clip. Plugins will paste any plug-in attributes to the clip. Equalizer will past EQ data copied from another clip. One or all of these can be copied at one time.

The Remove Attributes dialog box gives you the same three types of attributes to choose from for removal of a clip.
Chapter 174

Mixing in the Fairlight Page

The Mixer is the spider at the center of the web that is the Fairlight page, and provides the primary tools you’ll use to mix the various audio tracks of your program into a harmonious whole using EQ, Dynamics, Panning, level control, and VST and Audio Units audio effects of all kinds, all with full automation, to hone your sound and balance each track’s elements with the others. This chapter focuses on explaining the various functions of the Mixer so you can harness its power for yourself.

Contents

Introduction to Mixing 3260
The Mixer 3260
Tracks and Buses 3261
Bus to Bus Routing and Mixing 3261
Customizing the Onscreen Mixer Controls 3263
Managing Channel Strips Using the Index 3264
Selecting Channel Strips and Tracks 3265
Multiple Selection of Mixer Tracks 3265
Track Organization 3265
Input 3266
Effects 3266
Insert 3267
EQ 3267
Master EQ Controls 3267
Graphical EQ Controls 3268
Bands 1 and 6 3268
Bands 2–5 3269
Introduction to Mixing

This chapter describes the use of the Mixer to adjust the levels and fine-tune the audio of each track in the timeline. It’s focused on the function of the channel strip controls, with the following exceptions:

– For more information about busing, see Chapter 168, “Setting Up Tracks, Buses, and Patching.”
– For more information about recording audio, see Chapter 170, “Recording.”
– For more information about recording automation, see Chapter 175, “Automation Recording.”

The Mixer

The Audio Mixer provides a set of graphical controls you can use to assign track channels to output channels, adjust EQ and dynamics, set levels and record automation, pan stereo and surround audio, and mute and solo tracks. At its most basic, each audio track in your timeline corresponds to an individual channel strip in the Mixer, and by default there’s a single Main bus labeled Main that combines all these tracks into an overall mix.
Tracks and Buses

Once you start creating buses, the Audio Mixer exposes two sets of channel strips. The leftmost set of channel strips correspond to the audio tracks in the Timeline, while the right-most set of channel strips expose sets of controls for each bus that you’ve created.

Bus to Bus Routing and Mixing

The new Fairlight audio engine has advanced capabilities in the bus structure within Fairlight. The new busing system, called Flexbus, offers complete user flexibility for bus types and signal routing, which changes the prior Main, Sub, and Auxiliary bus formats to be completely user-definable. This new structure makes it possible to patch outputs and/or sends in any way you need, as dictated by your project. Each track can now output to up to ten buses and sends with additional level and pan controls to a further ten buses. Buses can be sent to other buses up to six layers deep, facilitating complex stem building, processing, and allowing discrete deliverables.
User-definable buses allow for bus-to-bus, bus-to-track, or track-to-bus routing, with each bus having the ability to pass signals from mono to fully immersive formats, such as Dolby Atmos, at the user’s discretion. As with any and all of the tracks in Fairlight, these bus types can be changed at any time by the user, if needed.

The Flexbus structure allows for many different bus track types to be created or changed.

The power of the Flexbus system is that it allows users to direct signals to many different places at one time to achieve complex mixing scenarios. Perhaps you need to generate two mixes that are identical in content but need to be of different output levels. You can designate two mix buses, one with an output level of -2dB true peak and one with an output level of -10dB true peak. The final mix signal is sent to one bus that is then broken into two more buses, one with a limiter set to -2dB and one set to -10dB creating these two different mixes at one time.

Flexbus has substantially expanded Dolby Atmos capabilities, for more information, see Chapter 180, “Immersive Audio Workflows.”

How Bus Outputs and Group assignments appear in DaVinci Resolve 17 and higher.

Using Legacy Fixed Busing

If you want to work using the previous method of fixed bus mapping, you can do so for new projects by opening the Fairlight panel of the Project Settings, and turning on the “Use fixed bus mapping” checkbox. This checkbox can only be enabled in new projects in which no timelines have yet been created. Once you’ve created one or more timelines, this option is locked to whatever it was set to. Older projects have this setting enabled by default to preserve the previous mix.
Legacy Busing

Due to the new Flexbus busing, the Mixer looks slightly different from versions prior to DaVinci Resolve 17. Specifically, the Aux panel on the old Mixer has been renamed Bus Send and the the Main/Submix panel has been changed to Bus Outputs.

Each audio track’s channel strip has a set of Main and Submix bus buttons that let you assign the audio output by that channel strip to a Sub (typically used to combine different subsets of tracks into submixes) or to a Main (typically used to output or render overall mixes). Each Sub and Aux’s channel strip has a set of Main buttons so that different combinations of Subs can be assigned to each Main. Main channel strips have no buttons because, from a busing perspective, they’re the final output.

Customizing the Onscreen Mixer Controls

The Option menu at the upper right-hand corner of the Mixer provides a number of different options for customizing the look of the Mixer, as well as which controls are shown or hidden.

First, you have the options of showing the Full Track Mixer or the Small Track Mixer. While the Full Track Mixer provides more room for buttons and controls that are large enough you don’t have to squint to see them, the Small Track Mixer lets you have many more channel strips onscreen at one time, for those times where you’re doing incredibly ambitious mixes.
Second, there's an option to Show Labels, which are the control names listed in a column to the left of the mixer channel strip area. If you’re first getting started, these Labels are useful, but once you’ve gotten used to the layout of the Mixer, hiding these will give you a bit more room to work with for another channel strip or two.

Third, there’s a set of options that let you toggle the visibility of specific channel strip controls, so you can hide controls you know you’re not going to be using, or that you’ve used but no longer need to adjust or want to protect from accidental adjustment by a wandering mouse or pen.

**Managing Channel Strips Using the Index**

The Index is a consolidated list view of all the tracks in the current Timeline, designed to make it easier to manage timelines with lots of tracks. Columns let you see each track's visibility, track number, name, controls, channel format, and Group assignment. The controls in these columns let you manage the tracks in the current Timeline by showing or hiding them, toggling track controls, or rearranging them. You can also right-click on one or more selected tracks to color code them, or change the channel assignment.

![The Tracks panel of the Index showing all tracks on both the Timeline and the Mixer](image)

**Showing and Hiding Tracks**

You can use the Tracks panel of the Index to hide tracks you don’t need to work on in order to create more room for tracks you need to see. To quickly show or hide a number of tracks, you can click and drag up or down over the eyeball button of each track for which you want to reverse the visibility.

**Color Coding Tracks**

Select one or more tracks, then right click one of the selected tracks and choose a color from the Change Track Color submenu of the contextual menu.

**Toggling Lock, Record, Solo, and Mute**

You can also use the Lock, Record, Solo, and Mute controls to quickly enable or disable multiple tracks by clicking and dragging up or down over the Lock, R, S, or M buttons you want to toggle.

**Rearranging Tracks**

Finally, you can rearrange tracks using the Index by clicking any track strip area between other controls, and then dragging that track up or down in the Index. As you drag, a white line shows you where that track will be inserted when you drop it. You can even select a contiguous series of tracks and drag them all to a new position in the Timeline at once.

**Reassigning Channel Mappings**

Select one or more tracks, then right click one of the selected tracks and choose a channel assignment from the Change Track Type to submenu of the contextual menu.
Selecting Channel Strips and Tracks

When you select a track in the Timeline, you also select that track's accompanying channel strip, and vice versa. It's possible to select multiple tracks in the Timeline and thereby select multiple channel strips, but you can also Command-click to select multiple channel strips in order to select multiple tracks.

Selecting multiple channel strips results in the selection of multiple tracks

Multiple Selection of Mixer Tracks

You can select multiple channel strips in the Mixer panel, which in turn selects those tracks in the Timeline. These selections can be made by command-clicking each track you want to add to the selection, or by clicking on one track and then dragging a bounding box around all other tracks you want to select.

Track Organization

Each channel strip has three organizational properties that let you keep track of which channel strip is responsible for which part of the mix.

– **Track color:** Each track can be differently color-coded, to help you keep organized. These colors appear in the timeline track header, the mixer, and the meters to help you keep track of which track corresponds to which channel strip and meter.

– **Track number:** The number of the timeline audio track corresponding to each channel strip appears here.

![The track color and track number appear at the top of each channel strip](image)

– **Track name:** This mirrors the track name found in the header controls of the timeline. If you customize an audio track's name in the Timeline or in the Mixer, that name appears here.

![Each track's name appears between the assignment buttons and the arm/solo/mute buttons](image)
**Input**

A drop-down menu that lets you patch inputs, patch buses, and configure the input settings of audio signals routed through Blackmagic hardware interfaces.

The Input drop-down menu provides shortcuts for patching different buses using the Patch Input/Output window.

For more information on using the options of the insert menu, see Chapter 168, “Setting Up Tracks, Buses, and Patching.”

**Effects**

When you apply Fairlight FX, VST, or Audio Unit effects to a track from the Effects Library, those effects appear here. Clicking the Plus button opens a drop-down menu with which you can apply any VST or AU effects installed on your machine to that track.

Hovering the mouse over any listed effect reveals controls for enabling/disabling each effect, opening an effect’s custom controls, and deleting that effect.

For more information on using audio effects, see Chapter 176, “Audio Effects.”
**Insert**

Enables the routing of effects from Blackmagic audio interface hardware to outboard effects boxes and back again. This button can be toggled to enable/disable such routing.

**EQ**

Double-clicking exposes a four-band parametric equalizer with additional Hi and Lo Pass filters, that has both graphical and numeric controls for boosting or attenuating different ranges of frequencies of audio on each track. You can select from among four types of EQ filtering from the Equalizer Type drop-down menu, with options for Earth (the default), Air, Ice, and Fire. The Equalizer Types available in the drop-down menu control the transfer function of the curve controls. Each band has controls for the filter type (Bell, Lo-Shelf, Hi-Shelf, Notch), Frequency, Gain, and Q-factor (sharpness of the band), with the available controls for each band of EQ changing depending on the filter type.

The channel strip EQ window

When a channel strip’s EQ is enabled, the EQ button displays the equalization curve that’s being applied. This indicator cannot be adjusted, you must open the EQ window to make modifications.

Master EQ Controls

The Equalizer window has the following overall controls:

- **Enable button**: Turns the overall EQ effect off and on, without resetting the controls.
- **Reset button**: Resets all controls of the EQ window to their defaults.
– **Equalizer Type:** Changes the EQ control functionality to emulate different EQ characteristics from “classic” mixing consoles. Specifically, they determine the transfer function of the curve controls. There are four options:
  – **Earth:** (Default) Native Fairlight controls
  – **Air:** Emulates the SSL 4K
  – **Ice:** Emulates the Neve V
  – **Fire:** Emulates the Focusrite

– **Gain fader:** A post-EQ level control that lets you boost or attenuate the signal to compensate for the EQ adjustment you’re making raising or lowering the level.

**Graphical EQ Controls**

A graph at the top shows a curve with handles that correspond to each of the enabled EQ bands listed below. You can drag any numbered handle to boost or attenuate the range of frequencies governed by that band, using whatever type of equalization that band has been set to.

![EQ graph with user-draggable handles](image)

Dragging the numbered handles on this graph in turn modifies the parameters of the corresponding band, and changing each bands parameters will also alter the EQ graph, which serves the additional purpose of providing a graphical representation of the equalization being applied to that track.

**Bands 1 and 6**

The outer two sets of band controls let you make high-pass and low-pass adjustments, if necessary. They’re off by default.

![The Band 1 and 6 controls](image)

– **Band enable button:** Clicking the band name turns each band of EQ on and off.

– **Band filter type:** Bands 1 and 6 can be switched among four specific filtering options for processing the lowest or highest frequencies in the signal. These include (from top to bottom) Hi-Shelf, Hi-Pass, Lo-Pass, and Lo-Shelf.
– **Frequency**: Adjusts the center frequency of the EQ adjustment
– **Gain**: Adjusts the amount by which the affected frequencies are affected. Negative values attenuate those frequencies, while positive values boost those frequencies.

### Bands 2–5

The middle four sets of band controls let you make a wide variety of equalization adjustments. They’re on by default, to make it easy to begin making adjustments.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Band enable button</strong></td>
<td>Clicking the band name turns each band of EQ on and off.</td>
</tr>
<tr>
<td><strong>Band filter type</strong></td>
<td>Bands 2–5 can be switched among four different filtering options (from top to bottom) Lo-Shelf, Bell, Notch, and Hi-Shelf</td>
</tr>
<tr>
<td><strong>Frequency</strong></td>
<td>Adjusts the center frequency of the EQ adjustment</td>
</tr>
<tr>
<td><strong>L, ML, MH, H Buttons</strong></td>
<td>Sets the EQ frequency to predetermined starting points per band of Low, Medium Low, Medium High, and High settings.</td>
</tr>
<tr>
<td><strong>Gain</strong></td>
<td>Adjusts the amount by which the affected frequencies are affected. Negative values attenuate those frequencies, while positive values boost those frequencies.</td>
</tr>
<tr>
<td><strong>Q Factor</strong></td>
<td>Adjusts the width of affected frequencies. Lower values include a wider range of frequencies, higher values include a narrower range of frequencies. The Equalizer Types in the drop-down menu alter the Q to mimic the emulated console type.</td>
</tr>
</tbody>
</table>

### Dynamics

Double-clicking exposes a set of dynamics controls with three sets of controls corresponding to an Expander or Gate, a Compressor, and a Limiter that can be used separately or in concert to manage the dynamics of the audio on that track.
The channel strip Dynamics control window

When you enable whatever combination of dynamics controls you need for that track, the dynamics graph updates with curves that show you how the signal is being affected by the Expander or Gate, Compressor, and/or Limiter settings that are being applied.

The dynamics graph shows how the signal is being affected by the current settings

With these dynamics enabled, the Dynamics button on the channel strip displays these curves, so you know what’s happening to that channel. This indicator cannot be adjusted, you must open the Dynamics window to make modifications.

The channel strip’s Dynamics indicator, (Left) Dynamics at detent, (Right) Dynamics adjusted
Master Dynamics Controls

The Dynamics window contains the following overall controls at the top of the window:

- **Reset button:** Resets all controls of the EQ window to their defaults.
- **Make Up fader:** A post-Dynamics level control that lets you boost the signal to compensate for dynamics settings that have lowered the level.

### Expander/Gate

The first of three sets of dynamics parameters, these controls can be switched between expansion and gating. Expansion emphasizes differences in volume by lowering the level of soft parts of the signal relative to the level of louder parts, and can be used to minimize noise while increasing the dynamic range of a signal. Gating reduces the level or even silences parts of a signal that fall below a certain level threshold in order to reduce or eliminate noise in quiet parts of a recording.

- **Expander:** A button that lets you enable these controls and switch them to perform expansion.
  - **Threshold:** Sets the signal level below which gain reduction occurs. Defaults to –35dB. The range is from –50 to 0dB.
  - **Range:** Unused for expansion.
  - **Ratio:** Sets the gain reduction ratio (input to output) that’s applied to signals which fall below the threshold level. Defaults to 1.1:1. The range is 1.0:1 to 10:1.
  - **Attack:** Adjusts how quickly the sidechain detector applies expansion when a signal exceeds the threshold. Defaults to 1.4mS (milliseconds). The range is 0 to 100mS.
  - **Hold:** Keeps dynamics from being triggered again until a certain amount of time has passed, in mS. Defaults to 0mS. The range is from 0 to 4000mS.
  - **Release:** Adjusts how quickly or gradually the sidechain detector stops applying dynamics when a signal goes back below the threshold. Defaults to 93mS. The range is 0.03 to 4.03mS.

- **Gate:** A button that lets you enable these controls and switch them to perform gating.
  - **Threshold:** Sets the signal level below which gain reduction occurs. The range is from –50 to 0dB.
  - **Range:** Sets the maximum amount of gain reduction that will be applied when the signal falls below the gate threshold. Once the signal has fallen below the level determined by the gate threshold minus the gate range, no gain reduction is applied. The default is 18. The range is from 0 to 60.2dB.
  - **Ratio:** Unused for gate.
  - **Attack:** Adjusts how quickly the sidechain detector applies gating when a signal exceeds the threshold. Defaults to 1.4mS. The range is 0 to 100mS.
  - **Hold:** Keeps dynamics from being triggered again until a certain amount of time has passed, in mS (milliseconds). Defaults to 0mS. The range is from 0 to 4000mS.
  - **Release:** Adjusts how quickly or gradually the sidechain detector stops applying dynamics when a signal goes back below the threshold. Defaults to 93mS. The range is 0.03 to 4.03mS.
Compressor

The second set of dynamics parameters let you apply compression, which detects the envelope of an audio signal in order to automatically change its level. Typically used to detect and reduce the peaks of an audio signal so that the overall level can be boosted without clipping, thus reducing the dynamic range of a given signal. Compression is often used to allow voices to have more presence within a mix, and to smooth out changes in the levels of tracks with too much dynamic range for the task at hand.

- **Compressor**: A button that lets you enable compression.
- **Threshold**: Sets the signal level above which compression is applied. The default is –15dB. The range is –50 to 0dB.
- **Ratio**: Adjusts the compression ratio. This sets the gain reduction ratio (input to output) applied to signals which rise above the threshold level. The default is 2.0:1. The range is 1.0:1 to 10:1.
- **Attack**: Adjusts how quickly the sidechain detector applies compression when a signal exceeds the threshold. The default is 1.4mS (milliseconds). The range is 0 to 100mS.
- **Hold**: After the attack phase has been completed, the Hold parameter controls how long this initial attenuation is maintained, before entering the release phase. Defaults to 0mS. The range is from 0 to 4000mS.
- **Release**: Adjusts how quickly or gradually the sidechain detector stops applying dynamics when a signal goes back below the threshold. The default is 93mS. The range is 0.03 to 4000mS.
- **Send**: Enable Send when you want to use the audio levels of the currently selected track to attenuate those of another track using sidechain compression. For example, you can turn on the compressor and enable Send for all tracks with dialog, in order to use those levels to attenuate the levels of another track containing music.
- **Listen**: Enable Listen when you want to use the audio levels of tracks that you set to Send to attenuate the levels of the currently selected track. If there are no tracks with Send enabled, then the current track is compressed as usual, using itself as the sidechain.

The following procedure shows how to set up a Compressor to automatically attenuate, or “duck” a music track whenever someone speaks in clips on one or more other tracks of the Timeline.

**To use sidechain compression to automatically “duck” music in the presence of dialog on other tracks:**

1. Edit dialog into one track of the Timeline, and edit overlapping music into another track of the Timeline.

   ![Choosing the track header in the Fairlight timeline to add Dynamics]

2. Click the track header or channel strip of a track with dialog to select that track, and then double-click the Dynamics indicator on the channel strip in the Mixer to open the Dynamics window.
3 Turn on the Send button to automatically send all levels from that track to the sidechain of a Compressor on another track (it’s not necessary to turn on Compressor for this). If you hover the pointer over the Send button, a tooltip will show you which tracks of the current timeline are set to Send.

4 If you have multiple tracks with dialog, you can repeat steps 2-3 for each so that the output levels of all dialog are sent to the sidechain.

5 Next, click the track header or channel strip of a track with music to select that track. If you haven’t closed the Dynamics window, the header will show you that the Dynamics controls are now those of the newly selected track.

6 Turn on Compressor, and then turn on the Listen button to automatically feed all “sent” levels to the sidechain of the Compressor on this track. If you hover the pointer over the Listen button, a tooltip will show you which tracks of the current timeline are set to Listen.

7 At this point, you need to lower the Threshold and raise the Ratio controls to the appropriate levels so that as dialog is heard, the music is compressed to be less loud. You may also want to raise Hold so this gain reduction doesn’t fluctuate too wildly, and raise Release so the volume adjustment doesn’t end too abruptly.

If you’ve set this up correctly, then during playback the Sidechain meter should show the levels of the dialog tracks with Send enabled, and the Gain Reduction meter should show you how much the gain of the music track is being reduced when triggered by the dialog being fed to the Sidechain.

As a result, you should hear that whenever speech plays, the music volume is automatically lowered. Adjust Threshold and Ratio to set the amount of this gain reduction, and adjust Attack, Hold, and Release to set how quickly gain reduction responds to changes in the Sidechain level (as defined by the Send levels).
Limiter

The third set of dynamics parameters let you apply limiting, which imposes a hard limit on the maximum level allowed for a particular signal.

- **Limiter**: A button that lets you enable Limiting.
- **Threshold**: Sets the maximum allowable output level. The default is –21dB. The range is from –50 to 0dB.
- **Attack**: Adjusts the attack rate time constant of the sidechain detector. The default is 0.71mS. The range is 0 to 100mS.
- **Hold**: Keeps dynamics from being triggered again until a certain amount of time has passed, in mS (milliseconds). Defaults to 0mS. The range is from 0 to 4000mS.
- **Release**: Adjusts how quickly the sidechain detector stops applying dynamics when a signal goes back below the threshold. The default is 90mS. The range is 0.03 to 4.03mS.

Track Processing Order in the Fairlight Mixer

The power of the built-in FX in Fairlight has been enhanced with the added functionality of a user-definable order of the processing chain in the Mixer.

The choice of what order to process tracks is dependent on the workflow of any given user as well as the needs of the media passing through it. This is to say that there is no right or wrong order for processing the audio.

Some mixer engineers will always put their EQ after the dynamics processing, while others will do the opposite. The FX may alter the EQ and dynamics in a way that it makes most sense to put them at the end of the processing chain. Or the complete opposite would work best. Now you can determine, on a track by track basis, what process order for that track and that mix is most appropriate.

The drop-down menu under Order on a channel strip shows the FX paths ordering.

**NOTE**: There are no hard and fast rules on processing order. Each track may have its own idiosyncratic needs for how the audio on that track will need to be processed. With a simple click the order can be changed and the results can be quickly auditioned.
Bus Sends

The Flexbus on the Mixer for DaVinci Resolve 17 is a bit different than on the Legacy Mixer if you are used to prior versions of DaVinci Resolve. Don’t worry, although the layout and names have changed a bit, the functions remain the same.

This allows you to route that track’s channels through a Bus Send. Each Bus Send corresponds to a specific Bus that you created. Double-clicking any of these bars opens up the Bus Send window, with which you can enable or disable Bus Sends, set each one to be routed pre the channel strip or post the channel strip (the default), and set the send level and pan value for each Bus Send. The controls for multiple Bus Sends appear stacked within a single window.

![Bus Send panel controls](image)

Each Bus Send you create exposes the following controls in the Bus Send window:

- **On**: Turns that Aux send on or off.
- **Pre**: Switches that Aux send to be processed either pre or post fader. Turning this button on enables that track to send levels to the Aux bus before level adjustments on that track are applied. One common use of this is to enable a plug-in applied by the Bus Send to continue to produce a “wet” version of that track’s audio while the mixing level is set all the way down, while raising the mixing level up mixes a “dry” version of the audio track against the “wet” levels produced by the Bus Send effect. For example, with Pre turned on you could slowly mix fade the original track level up over time over an Bus Send with a Delay effect to create the illusion that the echos of someone talking down a long hallway are giving way to a character’s own voice as they walk closer to the microphone.
- **Send Level**: Adjusts the amount of signal sent from the selected feed to the auxiliary bus. The range is OFF to +10dB.
- **Pan**: Provides panning across Bus Send destinations.

The level to which you set an Aux bus will be shown within the bar that represents that Aux bus in the Mixer’s channel strip.

![The Auxiliaries levels shown in the channel strip of the Mixer](image)
Legacy Auxiliaries

Prior to DaVinci Resolve 17 the Bus Send panel was called Auxiliaries. Any projects created prior to DaVinci Resolve 17 will use the legacy Fixed Busing. So for those of you, here is how the panel looks, again bearing in mind it functions the same way.

![The Auxiliaries control window for a mix with two Aux buses](image1)

Pan

The Mixer provides access to two kinds of pan controls, depending on whether you’re doing stereo and surround or 3D positioning in your mix.

The Stereo and Surround Pan Controls

A Pan control that’s compatible with stereo and surround panning. You can drag the panning on the Mixer strip handle within this control to adjust panning for stereo or surround mixing, or you can double-click this control to expose a large Pan window. What controls are available in the Pan window depend on the mapping of the audio track, but both stereo and surround panning controls are available, with corresponding numeric controls. You can either adjust panning using the graphical Pan control, or you can adjust specific panner characteristics using the controls to the left.

![The Pan control window](image2)
When a channel strip’s Pan control is enabled, the Pan area displays the panning that’s being applied. Unlike the EQ or Dynamics controls, you can adjust a channel’s panning by dragging the handles that appear within this small area of the channel strip.

The channel strip’s Pan indicator

The Audio Pan window contains the following controls:

- **Left/Right**: Changes the balance of signal between the left and right side speakers you’re outputting to, depending on what speaker format you’re mixing to. At its simplest, accommodates stereo output.
- **Front/Back**: Changes the balance of signal between the front and back sets of speakers you’re outputting to, depending on what speaker format you’re mixing to.
- **Rotate**: Simultaneously adjusts the left/right and front/back pan controls in order to rotate a surround mix about the centre of the room.
- **Spread**: Only available when a linked group of mono tracks is selected. Spread adjusts the perceived size of a surround mix.
- **Divergence**: Spreads the signal for an individual feed across more of the adjacent loudspeakers, making the perceived size of the sound source larger.
- **Boom**: The send level of that track to the LFE part of the mix.
  - **On**: Enables this functionality.
  - **Pre**: Lets you adjust the “dry” part of the signal separately from the “wet” part of the signal when effects are applied.

**The 3D Audio Pan Controls**

Option-double-clicking on the Pan control of the Mixer opens an alternate 3D Audio Pan window. Whereas the regular Pan window lets you do stereo and conventional 5.1 and 7.1 surround panning, the 3D Audio Pan window lets you do the kind of spatial audio positioning enabled by advanced surround formats such as Atmos, Auro 3D, and NHK 22.2.

The 3D Pan window
The 3D Audio Pan window has a few more controls than the ordinary Pan window:

- **Pan enable**: Toggles the entire panning effect on and off.

- **Panner viewer**: A large 3D representation of the listener’s perceived sound stage, with a blue sphere that represents the position of the track’s audio being positioned within that space, which casts a shadow straight down on the floor and projects a blue box on the four walls of this space to indicate its position more concretely.

- **Front panner**: A 2D panning control that represents the horizontal left/right axis and the vertical up/down axis, letting you make these specific spatial adjustments.

- **Side panner**: A 2D panning control that represents the horizontal front/back axis and the vertical up/down axis, letting you make these specific spatial adjustments.

- **Top panner**: A 2D panning control that represents the horizontal left/right axis and the vertical front/back axis, letting you make these specific spatial adjustments.

- **Left/Right**: A 1D knob that changes the balance of signal between the left- and right-side speakers you’re outputting to, depending on what speaker format you’re mixing to.

- **Front/Back**: A 1D knob that changes the balance of signal between the front and back sets of speakers you’re outputting to, depending on what speaker format you’re mixing to.

- **Rotate**: A 1D knob that simultaneously adjusts the left/right and front/back pan controls in order to horizontally rotate a surround mix about the center of the room.

- **Tilt**: A 1D knob that simultaneously adjusts the left/right and up/down pan controls in order to vertically rotate a surround mix about the center of the room.

- **Spread**: Only available when a linked group is selected. Spread adjusts the perceived size of a surround mix.

- **Divergence**: Spreads, or bleeds, the signal of an individual feed across the adjacent loudspeakers, making the perceived size of the sound source larger. A 2D button lets you see how this is done. With the 2D button turned off, divergence creates a one-dimensional bleed between the left/right planes only. With the 2D button turned on, divergence creates a two-dimensional bleed between both the left/right and front/back planes of sound.

- **Boom**: The send level of that track to the LFE part of the mix. An On button enables this functionality, while a Pre button lets you adjust the “dry” part of the signal separately from the “wet” part of the signal when effects are applied.

---

## Bus Assignment Buttons

Flexbus bus offers substantial options for bus routing. To route a created bus on the DaVinci Resolve 17 Mixer click the + sign to see a drop-down menu of all available buses.

The Bus Outputs panel is where you can route bus signals.

In the Legacy Mixer the bus assignments have two sets of buttons let you route audio from one channel strip's output to Sub and Main buses that you've set up for your mix.

The channel strip's bus assignment buttons
Main: These buttons let you assign a track or Sub’s channels to one or more of the main busses.

Submix: These buttons let you assign that track’s channels to one or more submix busses.

VCA Groups (Fader Groups)

You can assign multiple faders to a Fader Group, also referred to as “VCA group,” which is controlled by a dedicated group channel strip that appears at the right of the mixer. Fader Groups let you simultaneously adjust multiple faders using one group fader, for instances where that will help you manage the levels of complex collections of audio tracks.

The controls for doing this are found in the Group label area of each control strip, which also display which group each fader has been assigned to.

Making Fader Group Assignments

You can assign any fader to one of 64 groups by right-clicking the group label area and choosing a group from the drop-down that appears. If a fader is already assigned to a group, you can choose “No Group” to remove it.

NOTE: Each drop-down menu will only display ten groups initially. When those ten have all been assigned it will then display more available groups. This is in both Flexbus and Legacy Fixed Bus modes. When all 64 groups are in use the list is very long, so revealing only the first ten and then the subsequent buses is meant to reduce clutter.
Using Fader Groups

Once you’ve assigned multiple faders to a group, a dedicated channel strip for that group appears. Making adjustments to the group channel strip simultaneously controls all the faders, solo buttons, and mute buttons of all channel strips that are members of that group, as seen below.

![Fader Group Example](image)

Adjusting the Group 1 fader also adjusts the faders for Audio 1, 3, and 4 that are assigned to that group.

While in a group, you can still move the faders of each individual channel strip independently to make relative adjustments. Channel strip faders only move together when you adjust the group fader, and while the group fader is being moved, each individual fader’s relative offset from other faders in that group is maintained, as seen in the previous screenshot, where the Group 1 fader is moving the faders in tracks Audio 2, 3, and 4, but each individual channel strip fader in this group is offset from the others.

Recording Fader Automation for Groups

You can record automation data to the group fader, and all faders in that group will follow even though they’re not actually automated themselves. This makes it easy to record complex automation involving multiple faders when you still might want the freedom to finely adjust each individual fader later on.

Arm, Solo, and Mute Buttons

Identical to the controls found in the track header controls of each timeline audio track.

![Button Example](image)

The channel strip’s Arm, Solo, and Mute buttons

- **Record Arm**: (highlights red when enabled) Lets you enable a track to be recorded onto.
– **Solo**: (highlights green for Solo, blue for Solo Safe) Lets you mute all other tracks in order to play a track you need to focus on in isolation. If solo is enabled for multiple tracks, all soloed tracks will play, and all non-soloed tracks will be muted. This affects rendering, so if one or more tracks are soloed, the muted tracks won’t be output or rendered.

– **Solo Safe**: Command-Option-click a Solo button to put it into “Solo Safe” mode. Tracks set to Solo Safe, in which the Solo button is highlighted in blue, always play even if Solo is enabled for other tracks. This is good for tracks you want to continue listening to for reference even as you solo other specific tracks you want to pay more attention to.

– **Mute**: (highlights orange when enabled) Turning on Mute disables audio playback from that track. This affects rendering, so if one or more tracks are muted, they won’t be output or rendered.

**TIP**: You can click a button and drag across multiple channel strips to turn that button on or off for multiple tracks easily.

---

### Fader Controls

Each track’s vertical fader lets you control the level that’s output by that track, either using your mouse, or using the physical fader of your Fairlight console. If you’re working with a console, then the onscreen faders serve as a visual reference of what levels are set.

![The fader area](image)

– **dB**: Shows you the volume, in decibels, that track is currently set to.

– **Fader**: Each track’s vertical fader can be dragged with your mouse or other pointing device to adjust the volume of that track and perform automation recording. Dragging up increases volume, dragging down decreases volume. Fader handles turn red while you record levels automation, and they turn green when automation has been recorded for that track.

**Methods of adjusting channel faders:**

– **To change the level of that channel with the mouse**: Click and drag any fader up or down.

– **To reset the level of that channel to 0 dB**: Double-click a fader’s handle. This does not work after you’ve recorded automation for a track.
Bouncing Audio

Bouncing audio refers to mixing and rendering audio from one or more Timeline tracks onto another track of the Timeline, in the process “baking in” processor intensive effects and complicated or intricate audio edits to create a new continuous piece of audio media that’s written to the directory location specified by the “Save clips to” field of the Capture and Playback panel of the Project Settings.

There are two commands available for bouncing audio on the Fairlight page when you hit the wall with how many tracks and effects you can mix in real time.

– Timeline > Bounce Selected Tracks to New Layer
– Timeline > Bounce Mix to Track

To use Bounce Selected Tracks to New Layer:

1 Set In and Out points to define the range of the Timeline you want to bounce. If you don’t do this, nothing will happen.
2 Command click the track headers or mixer channel strips of all tracks you want to bounce in order to select them.
3 Choose Timeline > Bounce Selected Tracks to New Layer.

The audio on each track is processed and rendered and appears as the top layer of audio on that track. While View > Show Audio Track Layers is turned off, it will appear as if the new bounced audio is the only clip on that track. However, the original audio with live effects is still available as the bottom of the stack of layered audio on that track, and turning View > Show Audio Track Layers on will show this. The bounced audio is a new audio media file that’s written to the directory location specified by the “Save clips to” field of the Capture and Playback panel of the Project Settings.

To use Bounce Mix to Track:

1 Choose Timeline > Bounce Mix to Track. The Bounce Mix to Track window appears, showing each main, submix, and auxiliary that’s currently available.
2 In the Destination Track column, set which mixes you want to bounce by choosing either New Track, or choosing a specific existing track from the drop-down menus.
3 Click OK.

The specified mix is processed, mixed, and bounced to the specified track as a new piece of audio. This creates new audio media that’s written to the directory location specified by the “Save clips to” field of the Capture and Playback panel of the Project Settings.

TIP: There’s also a Bounce Audio Effects command in the contextual menu of audio clips in the Timeline that have audio plug-ins applied to them. For more information, see Chapter 176, “Audio Effects.”

Multi-Channel Bouncing

Audio clips linked in the Timeline can be bounced to a multi-channel file.

To link clips:

– Right-click the files in the Timeline and choose Link Clips from the contextual menu.
– Right-click the linked clips and choose Bounce to disk from the contextual menu, making sure to set the bounce to multi-channel.
The Bounce to Disk dialog box allows for choosing Bit Depth, File Name, Tag, and Folder destination.

The Bounce Clip to File dialog box offers naming, destination, and user-defined bit depth.

**Third-Party Control Panel Support for Mixing**

DaVinci Resolve supports HUI- and MCU-compatible third-party mixing control panels with up to eight faders, such as the Mackie MCU Pro Control Surface, connected via USB MIDI, and selectable in the Control Panels panel of the Resolve System Preferences. Supported basic panel controls that correspond to Fairlight features at the time of this writing include the following.

**Transport controls including:**
- Rewind (REW)
- Fast Forward (FF)
- Stop (double-press the Stop button for Home in the Timeline)
- Play (double-press the Play button to “play again”)
- Record (press Record+Play to begin recording if one or more tracks is record-enabled)
- Jog control (Press SCRUB and rotate the jog wheel)

**Channel Strip controls including:**
- Rotary controls for panning, with Rotary Value display and Rotary touch
- Alphanumeric Track Name display
- Record button to record-enable tracks (only works if an input is patched to a track input)
- Solo, with a double-press selecting or de-selecting that track
- Mute
- Select to select the track corresponding to that channel strip
- Fader control and optional Level display
- Channel and Fader Bank buttons to move left and right among banks of channel strips
- Double-press the Fader Bank Left button to move the playhead Home in the mixer (track 1)
- Double-press the Fader Bank Right to move to the Master channel strips

**Marker buttons:**
- Marker to add a marker
- Pressing the Marker+Stop buttons sets Home
- Pressing the Marker+FF/REW buttons jumps the playhead forward or backward
Additional supported controls for control panels that have them include:

- Master Solo clear/restore
- Undo (pressing the Undo+Option buttons does Redo)
- Arrows to move the selection
- Zoom horizontal and vertical controls
- Audio Tracks, to turn Automation On/Off
- Write/Trim/Touch/Latch switches
- Nudge controls
- Cut, Copy, and Paste

Monitoring controls include:

- Level control
- Dim
- Mute
- Alt Speaker

For more information on third-party mixing control panel support, see the Blackmagic Support site at https://www.blackmagicdesign.com/support/family/davinci-resolve-and-fusion.
Chapter 175

Automation Recording

The Fairlight page provides simple, flexible, and comprehensive facilities for recording and editing mix automation data. Once recorded, all feed and bus mix parameter automation can be played back in perfect synchronization with the audio, including channel parameters, bus assignments, inserts, and direct outs.

The Fairlight page is designed to allow the operator to record every static and dynamic parameter change you make in the process of balancing the mix of tracks in the timeline. Mixer adjustments may be recorded for one or multiple parameters or channels at a time. Additionally, more adjustments may be added with each automation recording pass, which lets you create complex and detailed mixes that can be frame-accurately replayed at will.

This chapter covers automation mixing using the combined controls of the onscreen mixer and timeline. For more information on basic mixing operations, see Chapter 174, “Mixing in the Fairlight Page.”

Contents

Automation Recording 3286
What You Can Automate 3286
Automation Controls 3286
How to Record Automation 3287
Recording Automation for Multiple Tracks 3287
Recording Automation for Specific Individual Tracks 3288
Automation Preview Mode 3289
Viewing Automation in the Timeline 3290
Overwriting Automation 3291
Automation Recording

While the recording of keyframe automation is most commonly associated with either the onscreen mixer or the Fairlight console, you can also record automation using controls found in the Inspector, or using the controls of the EQ, Dynamics, and Pan windows, thereby enabling you to record automation for the various audio effects that you’ve applied to a track.

Recording automation refers to creating high-fidelity data that records changes you make to onscreen controls and/or Fairlight console controls, in real time as the Timeline plays, that will then control how those parameters will play back. In this way, you can create a dynamic mix where different audio level, pan, and EQ, dynamics, and other audio processing settings change over time to fade swells of music up and down, pan the sound effect of a car driving by from the left to the right speaker, or slowly increase the strength of a reverb effect applied to foley footsteps as a character walks into a long, dark cavern.

What You Can Automate

You can record automation for nearly every control in the mixer for channel strips corresponding to individual tracks, track groups, or busses, including the fader. Additionally, you can record automation for controls found in audio plug-ins that you use in your mix.

Automation Controls

The automation button, to the right of the transport controls, lets you show and hide the Automation toolbar.

The Automation toolbar has buttons for each option that’s available for preparing to record automation in your mix.
The Automation toolbar displays the following options:

- **Automation**: Controls how automation data is recorded.
  - **Write**: Records absolute changes to control automation.
  - **Trim**: Records relative changes to control automation in order to increase or reduce levels that have already been recorded.

- **Touch**: Defines what happens when you first adjust an automatable control.
  - **Off**: No automation is recorded.
  - **Latch**: Automation is recorded once you begin moving a control and continues recording after you release the control.
  - **Snap**: Automation is recorded once you begin moving a control and stops recording after you release the control; there is a brief interpolation from the last parameter you set to the prior recorded level.

- **On Stop**: Defines what happens when you release an automatable control.
  - **Event**: The last recorded automation value overwrites previous levels to the start of the next available recorded automation data (or event) in that track.
  - **Hold**: Deletes all previously recorded mixing data after what you’ve just recorded, to hold the last recorded level for the rest of that track.
  - **Return**: The last recorded automation value is interpolated to ramp back to the previously recorded automation values on that track.

- **Enables**: The following buttons let you enable or disable different controls for recording automation.
  - **Fader**: Automates track and bus volume.
  - **Mute**: Automates the mute button.
  - **Pan**: Automates all pan controls.
  - **EQ**: Automates all EQ controls.
  - **Comp**: Automates just the Compressor controls in the Dynamics window.
  - **Gate**: Automates just the Gate controls in the Dynamics window.
  - **Lim**: Automates just the Limiter controls in the Dynamics window.
  - **Aux**: Automates the Auxiliary controls in the Auxiliaries window.
  - **Plug-ins**: Automates all plug-ins.
  - **Misc**: Automates the parameters of VST and Audio Unit plugins.

**How to Record Automation**

There are two different ways you can set up the recording of automation for levels, panning, EQ, Dynamics, and other audio controls in the mixer.

**Recording Automation for Multiple Tracks**

You can use the following steps to record automated changes to any audio control in any control strip:
1 Open the Automation toolbar, and do the following three preparatory steps:
   a. Choose whether you’re going to write new automation, or trim automation that’s already recorded. Write mode is appropriate when you’re recording automation for the first time, or when you’re overwriting previous automation with brand new values. Trim mode is appropriate when you’re making incremental changes to previously recorded automation.
   b. Next, choose Touch and On Stop behaviors that are appropriate for the kind of automation recording you need to do.

2 Move the playhead to the beginning of the section of the timeline you want to record automation for.

3 Next, initiate playback using any method (Spacebar, L, Play button, third-party or Fairlight audio control panel), and make whatever adjustments you want to the controls for which you’ve enabled automation recording. As you make adjustments, the affected fader control turns red to let you know you’re recording automation.

4 When you’re finished, stop playback using any method (Spacebar, K, Stop button, third-party or Fairlight audio control panel). Automation recording stops as well.

Recording Automation for Specific Individual Tracks

You can use the following steps to record automated changes to controls in specifically armed control strips:

1 Open the Automation toolbar, and do the following three preparatory steps:
   a. Choose whether you’re going to write new automation, or trim automation that’s already recorded. Write mode is appropriate when you’re recording automation for the first time, or when you’re overwriting previous automation with brand new values. Trim mode is appropriate when you’re making incremental changes to previously recorded automation.
   b. Next, set Touch to Off, which disables across-the-board automation recording and requires you to arm specific tracks that you want to automate.

2 Click the automation arm button above the fader of any Mixer track or any track header to which you want to record automation. Even though the Touch control is set to off, moving a control on an armed channel strip will record automation in Latch mode.

![The automation arming button above a fader in the Mixer]
3 Move the playhead to the beginning of the section of the timeline you want to record automation for.

4 Next, initiate playback using any method (Spacebar, L, Play button, third-party or Fairlight audio control panel), and make whatever adjustments you want to the controls for which you’ve enabled automation recording. While you make adjustments, the affected fader control turns red to let you know you’re recording automation. If you’re displaying the same automation data in the Timeline that you’re recording, you can see the new automation being drawn in real time, in red.

5 When you’re finished, stop playback using any method (Spacebar, K, Stop button, third-party or Fairlight audio control panel). Automation recording stops as well. Displayed automation turns green once recording has stopped.

If you don’t like what you’ve done, you can undo and start over, or you can edit the automation using methods described later in this chapter. Or, you can back the playhead up and overwrite automation at any time with new automation.

**Automation Preview Mode**

Preview is an additional mix automation workflow, specifically for working across scene-based material. When enabled, mix items that are in preview are not controlled by pre-recorded automation, so they respond manually to their controls. These can subsequently be placed into write (or trim) to write actual automation.

Typically, Preview mode is used to audition new mix settings for one particular section of a timeline, while other sections already have recorded automation data. Preview mode prevents pre-recorded automation from moving the controls the user is trying to adjust in the targeted section. As soon as the user is happy with the new adjustments, they can be written to the targeted section.

Preview mode frees the faders (and other controls) from automation control, and lets you move them while you experiment with different levels and settings. Ordinarily, moving one or more controls implies writing automation data for those controls, but entering Preview mode lets you play with the controls as much as you like without committing to anything, only writing automation data when you’re ready.
To engage the Preview state on enabled mix items, first enter Preview mode by doing one of the following:

– Toggle Preview in the Automation toolbar.
– Press the Preview key on the Mix page of the Fairlight controller.

Once Preview is engaged:

– Individual parameters can be switched into Preview Touch Latch.
– You can use the AUTO key next to a fader to preview all enabled parameters on a channel.
– You can use the Auto button on the screen mixer strips.

When you’re in Preview mode, all parameters in Preview are indicated by a blue automation indicator.

Once in Preview mode, mix items can be placed into write (or trim) by:

– Dropping in manually via the “Punch In” menu item.
– Dropping in manually with the In key on the Fairlight controller.
– Automatically using the Active In and Out points on the Fairlight controller.

Once enabled for Preview, parameters remain in that state regardless of transport starts and stops. This is different from putting mix items into WRITE, which must be done again after each transport stop.

Other Preview-related operations include:

– Filling a range defined by In and Out points with all parameters currently in Preview.
– Gliding all parameters from their existing values at the Range In point to the Preview values at the Range Out point.

Viewing Automation in the Timeline

Once you’ve recorded automation keyframes for a particular parameter, they can be made visible in an automation graph in the Timeline. While the automation controls are visible, an additional pair of controls appear in the header of each audio track. A drop-down lets you choose which automation waveform to view, with options for Fader, Mute, Pan, EQ, Compressor, Limiter, Aux, Plugins, and Misc controls.
Overwriting Automation

Once you’ve recorded automation for a particular clip, you can overwrite that automation in subsequent passes. Using either of the previously described methods of recording automation, adjusting the levels of a track control with previously recorded automation displays a red line that shows the new level relative to the previously recorded level.

Setting new levels to overwrite previously recorded automation displays a red line

Pressing play to actually record this new automation will overwrite the previous levels at this new value.

New automation overwrites the previous levels

Automation data can be copied, pasted, and erased under the Fairlight Menu > Automation > Copy/Paste/Erase.

Automation Follows Edit

Picture lock can be an elusive thing, eventually devolving into multiple timelines named final_final_no_really_final_mix. Since additional sound editing is likely while projects are in the mixing phase, users can have their edits retain all of the automation data that has been added to audio clips during mixing. To enable this, choose Fairlight > Automation > Follows Edit.

This is also extremely useful when doing an initial edit of audio clips that contain automation data. For instance, if you have a recurring sound effect that pans left to right, first automate that panning to the audio clip. When this clip is copied through the Timeline it will retain the same panning automation for each new instance. This can be very useful for a variety of edits that require the same automation data for audio clips in a timeline.

Be aware, however, that it will need to be turned off when copying and pasting clips or sequences where the automation that has been applied is not relevant to the new edits.

The automation data is embedded into the clips themselves. Any of that data, for instance volume or panning, will travel with the clips. So if a complete section has been removed, all of the automation inside of the clips contained in that section are also removed. If a section of clips changes its location in the Timeline, all of the automation embedded in those clips move in the Timeline with them.
When the Automation is enabled in the Fairlight toolbar, the Automation Follows Edit button will appear.

The Automation Follows Edit button to the left of the Flag button on the toolbar

Editing Automation

When the automation toolbar is displayed, two additional tools appear in the regular toolbar. From left to right, these are the Pencil and the Select Range tools. These tools let you edit automation in different ways.

The Pencil and Select Range tools appear when you open the Automation toolbar

Drawing Automation Keyframes

You can use the pencil tool to literally draw new automation curves in the Timeline for whichever parameter’s automation data is visible. This can be a good way to smooth out ragged sections of automation without needing to re-record everything you did.

Simply click the Pencil tool, choose the automation data you want to edit in a track of the Timeline using the drop-down menu in the track header, and then click and drag to draw a new curve. While you’re drawing, the new curve appears in red, while the old curve appears in green, to help you see what you’re doing. When you’re finished, release the pointer button and the automation curve will be redrawn.

Using the Pencil tool to smooth out a section of automation

Adjusting and Deleting Automation Keyframes

The Select Range tool lets you adjust automation in two different ways.
Adjusting Individual Keyframes

Using the Select Range tool, you can click and drag any automation keyframe up or down and left or right (bounded by its neighboring keyframes) to adjust it directly. When zoomed in, this can be an effective way of making minute adjustments to troublesome keyframes. The segment of automation affected by the keyframe you’re dragging appears red to show you the new curve you’re creating, while the previously recorded curve remains green. When you release the pointer button, the new shape will be drawn.

![Using the Select Range tool to adjust an automation keyframe](image)

Adjusting and Deleting Multiple Keyframes

You can also use the Select Range tool to drag a bounding box to select multiple keyframes, in preparation for moving them or deleting them.

![Dragging a bounding box over a section of automation using the Select Range tool](image)

Once you release the box, that section of keyframes becomes highlighted.

![Multiple automation keyframes selected](image)

Once it’s highlighted, you can drag the selection to move it, or you can press the Delete key to delete it. The remaining section of the curve flattens out to fit the first and last keyframe of the selection.
Adding New Keyframes

You can also use the Select Range tool to add new keyframes to an automation curve. However, these are not Bezier keyframes, so they only let you create a single level adjustment at that frame. If you make a large adjustment with only a single new keyframe, you’ll end up with a squared off section of automation. For this reason, adding new keyframes should only be done when making small adjustments, unless you intend to create an abrupt change.

Fairlight > Automation Controls

A series of commands in the Fairlight > Automation submenu let you initiate various automation tasks. These commands are:

– **All Read:** Switches all parameters that are in Trim or in Write mode back to Read mode.

– **Punch In:** When Preview mode is on, switches all parameters currently in Preview (blue) into Write or Trim. When Preview mode is off, this switches all Automation-enabled parameters on all selected channels into Write or Trim.

– **Punch Out:** When Preview mode is on, switches all parameters currently in Write, Trim or Preview into Read. When Preview mode is off, this switches all Automation-enabled parameters on all selected channels into Read.

– **Fill Range:** When there is an active In and Out range in the Timeline, the current value of all parameters in Preview will be written over that range.

– **Glide Range:** In Preview mode, “glides” all parameters from their existing values at the In point to the preview values at the Out point of the Timeline.

– **Copy:** If there is an active In and Out range in the Timeline, this command copies the automation moves of all selected channels within this range to the clipboard (Range mode). If there is no active In and Out range, this command copies the position of all automated parameters on all selected channels at the playhead (Snapshot mode).
– **Paste**: Pasting of a clipboard can be done with a different target channel set and/or with a different target time. If there is an active In to Out range defined in the Timeline, and the clipboard is in Snapshot mode, then this range will be filled with static values of the snapshot data. If there is an active In to Out range defined, and the clipboard is in Range mode, then this range will be filled as appropriate with automation moves from the Clipboard. If there is no active In to Out range defined, then the automation clipboard is simply pasted in its entirety.

– **Erase**: If there is an active In and Out range in the Timeline, this command erases the automation moves of all selected channels within this range to the clipboard (Range mode). If there is no active In and Out range, this command copies the position of all automated parameters on all selected channels at the playhead (Snapshot mode).

## Playing Automation

After you’ve automated a mix, playing it back is as simple as moving the playhead to an area of the timeline prior to the recorded automation, and initiating playback. As the timeline plays, the onscreen controls for each automated parameter are shown in green, and move and update to show the recorded levels for those controls.

Green controls show which ones have recorded automation during playback
Audio plug-ins let you apply effects to the audio clips in your mix, such as echo or reverb, noise reduction, aural enhancement, click and pop removal, and so on. DaVinci Resolve is compatible with a wide variety of third-party VST and Audio Unit effects for audio processing, and these can then be used either in the Edit or Fairlight pages. This chapter goes through the different methods available for applying and customizing effects for clips and for tracks.

Contents

- Elastic Wave Audio Retiming
- About Audio Plug-Ins
- Fairlight FX
- VST and VSTi
- Audio Units
- Using Audio Plug-Ins
- Applying Audio Plug-Ins to Buses
- Dealing With Processor Intensive Plug-Ins
- Caching Audio Clips With Plug-Ins
- Bouncing Audio Clips With Plug-Ins
Elastic Wave Audio Retiming

Elastic Wave retiming is a fast and easy keyframe-based way of dynamically retiming audio, squishing and stretching different parts of a waveform to subtly retime audio playback for a variety of reasons, all while maintaining constant pitch. For example, if you’re using the audio from another take to replace that of the current take, but the performer’s timing is just a little bit different, you can use Elastic Audio to make small adjustments to retime the second performance to match the first.

To use Elastic Wave retiming on an audio clip:

1. In this example, two tracks of foley effects have been recorded, and the bottom one needs to be retimed to match the top one.

2. Right-click an audio clip and choose Elastic Wave retiming from the contextual menu to reveal the Elastic Wave retiming controls.

3. Command-click anywhere on the clip to add speed keyframes to parts of the waveform you want to retime by stretching or squishing. You can also place speed keyframes to lock parts of a waveform you don’t want to retime.
4 Dragging the speed keyframe to the left or right speeds up the audio on one side of the keyframe and slows down the audio on the other side of the keyframe, from that keyframe to the neighboring keyframes applied to that clip. Using an audio clip’s waveform as your guide, you can use multiple speed keyframes to match the waveform of one performance to the waveform of another, in order to make the timing match. Or, you can adjust speed keyframes freeform to manipulate performances or sounds for creative effect.

Adjusting a series of speed keyframes to retime one performance to match another

You can also drag the beginning or end of an audio clip to retime that portion of the clip going forwards or back to the next speed keyframe that’s been added.

5 If you’ve made some speed keyframe adjustments, but you find yourself wishing a speed keyframe you created had been placed at a different position relative to the audio waveform being adjusted, you can hold the Command key down and drag any speed keyframe to move it closer to or farther away from a part of the waveform you want it to retime. This fine-tunes the audio retiming adjustment occurring at that point in the clip.

(Left) Before Command-dragging a speed keyframe to be closer to the original beginning of the sound being retimed. (Right) After

6 When you’re done, you can click the close button at the upper-left-hand corner to hide the Elastic Wave retiming controls.
To remove Elastic Wave retiming keyframes, do one of the following:

- **To remove a single speed keyframe:** Right-click on a speed keyframe and choose Remove Speed Keyframe from the contextual menu.

- **To remove all speed keyframes and eliminate the Elastic Wave retiming effect:** Right-click a clip and choose Reset Speed Curve.

**NOTE:** All Elastic Wave retiming adjustments you make in the Fairlight page appear in the Edit page as variable speed effects, accessible using the Retime controls. Be aware that while all Elastic Wave retiming effects can appear as Edit page retime effects, not all Edit page retime effects can appear as Elastic Wave retiming effects on the Fairlight page.

### About Audio Plug-Ins

There is no limit to the number of single or multiple plug-ins when in Flexbus mode that can be applied to clips and to tracks. However there is a limit of 480 when using Fixed Bus Legacy. Plug-ins are accessed via each track’s control strip, or via the Inspector which provides access to both clip and track plug-ins.

**Fairlight FX**

Fairlight FX are a DaVinci Resolve-specific audio plug-in format that runs natively on macOS, Windows, and Linux, providing high quality audio effects with professional features to all DaVinci Resolve users on all platforms.

**VST and VSTi**

VST (Virtual Studio Technology) is an audio plug-in standard created by Steinberg. The VST standard allows third-party developers to create VST plug-ins for use within VST host applications, or to create VST host applications themselves. The VST plug-in standard is the most widespread audio plug-in standard in use today, with thousands of available plug-ins spanning the gamut from EQ and compression to reverb, denoising, de-essing, aural exciting, and much more.

The Fairlight page supports VST effects from Mono to 7.1 - and beyond. These effects can be inserted on mono channels or Link Groups. If a stereo VST effect is inserted on a LCR, LCRS, or 5.1 Link Group, the left and right channels will be allocated to left and right Link Group channels automatically.

As of this writing, DaVinci Resolve supports VST version 2.4. VST effects are available on macOS and Windows workstations, but not on Linux.

**VST Effects versus VST Instruments (VSTi)**

A VST effect is a type of VST plug-in that is used to process audio. A VST effect might be a Reverb, Compressor, or EQ. VST Instruments are typically used to synthesize sound or play back sampled audio. VSTs have rapidly replaced hardware synthesizers and dedicated samplers due to their flexibility, repeatability, and low cost.

**Audio Units**

Audio Units are an audio plug-in API created by Apple. Similarly to VST, Audio Units (AU) can either process audio, or work as instruments. Audio Units are only available on macOS workstations.
Using Audio Plug-Ins

Fairlight FX are pre-installed on all DaVinci Resolve installations. If you install additional VST or Audio Unit effects on your workstation, they appear in the Audio FX panel of the Effects Library, organized in separate categories.

Audio plug-ins in the Effects Library

You can click on the far right of any effect to flag it with a star as a favorite effect. When you do so, the favorited effects appear in a separate Favorites area at the bottom of the Effects Library Bin list, and it also appears at the top of the Effects button’s menu on the Mixer when you click the “plus” button.

Stars indicate a flagged favorite effect; all favorites are currently filtered

Audio plug-ins let you apply effects to individual audio clips or entire tracks worth of audio, to add creative qualities such as echo or reverb, or to take care of mastering issues using noise reduction, compression, or EQ.

Methods of applying audio plug-ins to clips on the Fairlight page:

– To apply an audio filter to a clip: Drag any filter from the Audio FX panel of the Effects Library onto the clip in the Timeline you want to apply it to.

– To apply an audio filter to multiple clips: Select all of the clips you want to apply an audio filter to, then drag any filter from the Audio FX panel of the Effects Library onto any of the selected clips.
When you apply an audio plug-in to a clip, a badge appears to the left of that clip’s name bar in the Timeline to let you know there’s an effect applied to it.

Timeline clips with audio plug-ins applied appear with a badge.

Methods of applying audio plug-ins to tracks on the Fairlight page:

– To apply an audio filter to an entire track in the Timeline: Drag any filter from the Effects Library onto the track header.

– To apply an audio filter to a track or bus in the Mixer: Drag any filter from the Audio FX panel of the Effects Library onto the clip in the Timeline you want to apply it to.

– To apply an audio filter to a track or bus using the Mixer controls: Click the plus button in the channel strip of the track you want to apply an effect to, and then choose a filter from the drop-down menu that appears. All filters appear within categories to make them easier to find. If you’ve clicked the star button of any filters in the Effects Library to favorite them, these favorite filters appear at the top of the plus button’s drop-down list.
TIP: The categories that audio filters are organized into in the Mixer can be edited in the audio plug-ins panel of the DaVinci Resolve System Preferences window. All plug-ins on a workstation are shown in the Available Plug-ins list, and clicking within the Category column lets you use a drop-down menu with which to change categories.

To edit a clip’s audio plug-ins:
- Select that clip and open the Inspector. All audio plug-ins applied to that clip appear in the Effects tab, with that filter’s controls appearing directly in the inspector.

To edit a track’s audio plug-ins, do one of the following:
- Click in the background of the Timeline header to select that track, and then open the Inspector. Click the custom UI button for that filter to open its controls.

- Move the pointer over the plugin’s name in the Effects area of the Mixer, and click on the custom UI button to open its controls.

Nearly all Fairlight FX, VST, and Audio Unit audio plug-ins have a custom user interface that makes it much easier to manipulate that filter’s controls. These can be opened from within DaVinci Resolve.
Methods of working with audio plug-ins in the Inspector:

- To rearrange the order of multiple video filters applied to a clip: Click the move up or move down buttons in any filter’s title bar, to the left of each filter’s Trash Can button.

- To disable or re-enable a filter: Click the toggle button at the far left of each filter’s title bar.

- To remove a filter: Click the Trash Can button.

- To reset any filter parameter: Click the Reset button at the far right of the parameter you want to reset.

- To open or collapse a filter’s parameters: Double-click the title bar.

- To open or collapse the parameters of all filters: Hold the Option key down and double-click any filter’s title bar.

Once applied to a clip or track, audio plug-ins can also be keyframed or automated just like volume and pan settings, to create dynamic audio effects that change over time.

Applying Audio Plug-Ins to Buses

You can apply audio plug-ins to Main and Sub buses just like any other track, with which to apply any audio mastering effects operations you require to individual submixes, or even to an entire main.

Dealing With Processor Intensive Plug-Ins

As you apply more and more plug-ins directly to clips in complicated mixes, you may discover you lack the processing power to play all audio tracks and effects in real time. When this happens, there are two ways you can ease the burden that audio clip effects are placing on your workstation.

Caching Audio Clips With Plug-Ins

One quick fix is to manually enable the caching of one or more selected audio clips with audio effects applied to them to improve your project’s performance. Once an audio clip is cached, all plug-in effects are “baked in” and that clip’s audio waveform updates to reflect the altered audio. Cached clips appear with a small badge to the right of the FX badge in the name bar of the clip.

This is a non-destructive operation that has no lasting effect on the source media of cached clips. You can still alter a cached clip’s plug-in parameters whenever you want. Opening the graphical controls of a cached clip temporarily suspends audio caching, and when you’re finished, the clip is automatically re-cached and its waveform is updated to reflect the change so long as Cache Audio Effects remains enabled.
To cache audio effects for one or more selected clips:
- Right-click an audio clip with a plug-in applied and choose Cache Audio Effects to enable audio effect caching for that clip. If you right-click one of multiple selected clips, you’ll enable Cache Audio Effects for all selected clips at once. Once enabled, that clip will be continue to be cached (and re-cached if you change the plug-in’s parameters) until you manually disable audio caching.

To disable audio caching for one or more selected clips:
- Right-click an audio clip that’s been cached and choose Cache Audio Effects to disable audio effect caching for that clip.

**Bouncing Audio Clips With Plug-Ins**

Another way of easing the burden of audio clip effects on your system is to bounce the effected clip to another layer. This creates a new piece of audio media with the effect “baked in,” which is written to the directory location specified by the “Save clips to” field of the Capture and Playback panel of the Project Settings.

To bounce one or more selected audio clips with effects to another layer:
- Right-click an audio clip with a plug-in applied and choose Bounce Audio Effects. If you right-click one of multiple selected clips, you’ll Bounce Audio Effects for each selected clip all at once. After bouncing an audio clip with effects, the original clip will be muted.

Bounced clips no longer have editable effects, but you can always choose View > Show Audio Track Layers to see the original underlying clip that still has the original plug-in effect applied, and you can unmute it, move it back up to the top, edit the effect, and bounce another version of the clip, which appears as the topmost layer.
Fairlight FX are a DaVinci Resolve-specific audio plug-in format that runs natively on macOS, Windows, and Linux, providing high-quality audio effects with professional features to all DaVinci Resolve users on all platforms. Thirteen new audio plug-ins that can be used both in the Edit and the Fairlight page include a wide variety of plug-ins for repairing faulty audio, creating effects, and simulating spaces. This chapter explains what they do and how to use them.

Contents

- Common Controls For All Fairlight FX 3306
- Chorus 3306
- De-Esser 3308
- De-Hummer 3309
- Delay 3310
- Dialog Processor 3311
- Distortion 3311
- Echo 3313
- Flanger 3314
- Foley Sampler 3315
- Frequency Analyzer 3319
- LFE 3319
- Limiter 3320
- Meter 3320
- Modulation 3321
- Multiband Compressor 3323
- Noise Reduction 3324
- Phase Meter 3325
- Pitch 3325
- Reverb 3326
- Soft Clipper 3327
- Stereo Fixer 3328
- Stereo Width 3329
- Surround Analyzer 3330
- Vocal Channel 3330
Common Controls For All Fairlight FX

Before going into the specific controls of each Fairlight FX plug-in, there are some common controls that all plug-ins share, found at the top of the custom GUI window for each plug-in.

- **Presets**: A cluster of controls that let you recall and save presets specific to each plug-in.
- **Add Preset button**: Click this button to save the current settings of the Fairlight FX you’re using. A dialog lets you enter a Preset name and click OK.
- **Preset drop-down menu**: All presets for the currently open plug-in appear in this menu.
- **Previous/Next preset buttons**: These buttons let you browse presets one by one, going up and down the list as you evaluate their effects.
- **A/B Comparison**: A set of buttons that lets you compare two differently adjusted versions of the same plug-in. The A and B buttons let you create two sets of adjustments for that plug-in, and toggle back and forth to hear which one you like better. The arrow button lets you copy the adjustments from one of these buttons to the other, to save the version you like best while experimenting further.
- **Reset**: A single reset control brings all parameters in the current plug-in to their default settings.

When the Automation is turned on, an automation button appears at the top right of each of the plug-ins. Automatable parameters for that effect are available in the Plug-in drop-down menu for that track.

Chorus

An effects plug-in. A classic Chorus effect, used to layer voices or sounds against modulated versions of themselves to add harmonic interest in different ways.

An animated graph shows the results of adjusting the Modulation parameters of this plug-in, giving you a visualization of the kind of warble or tremolo that will be added to the signal as you make adjustments.
The Chorus Fairlight FX

Chorus has the following controls:

- **Bypass**: Toggles this plug-in on and off.
- **Input Format**: (Only visible when Chorus is inserted on a multi-channel track.) Lets you choose how multiple channels are input to the Chorus. Stereo sets separate Left and Right channels. Mono sums Left and Right to both channels. Left inputs the Left channel only, and Right inputs the Right channel only.
- **Delay**: The amount of delay between the original sound and the Chorus effect.
  - **Delay Time**: Length of the Chorus delay lines.
  - **Separation**: Time separation of the delay voices.
  - **Expansion**: Sets L/R length differences, phase offset of modulators
- **Modulation**: These controls adjust the low frequency oscillator (LFO) that drives the tremolo of the chorus effect in different ways.
  - **Waveform**: Specifies the shape of the LFO that modulates the rate of the Chorus, affecting the timing of the oscillations. There are six options: Sine (smooth oscillations), Triangle (sudden oscillations), Saw1, Saw2 (jerky oscillations), Square (hard stops between oscillations), and Random (randomly variable oscillations).
  - **Frequency**: Rate of LFO controlling the Chorus. Lower values generate a warble, higher values create a tremolo.
  - **Pitch**: Amount of frequency modulation, which affects the pitch of the Chorus.
  - **Level**: Depth of level modulation. Affects the “length” of the segment of Chorus that’s added to the sound. Low values add only the very beginning of the Chorus effect, high values add more fully developed Chorus warble or tremolo.
- **Feedback**:
  - **Amount (%)**: The percentage of signal fed back to the Chorus Delay Line. Values can be positive or negative, the default is 0 (no effect). Increasing this parameter adds more of the Chorus effect to the signal, lowering this parameter adds more of the inverted Chorus effect to the signal. At values closer to 0, only a faint bit of Chorus can be heard in the audio, but at values farther away from 0 (maxing at +/- 99), a gradually pronounced Chorus becomes audible.
  - **Blend (Hz)**: Amount of feedback which bleeds into the opposite channel (Stereo mode only).
– **Output**: Controls for adjusting the final output from this plug-in.
– **Dry/Wet (%):** A percentage control of the output mix of “dry” or original signal to “wet” or processed signal. 0 is completely dry, 100% is completely wet.
– **Output Level (dB)**: Adjusts the overall output level of the affected sound.

## De-Esser

A repair plug-in specific to dialog. The De-Esser is a specialized filter that’s designed to reduce excessive sibilance, such as hissing “s” sounds or sharp “ts” sounds, in dialog or vocals.

A graph shows you which part of the signal the controls are set up to adjust, while reduction and output meters let you see which part of the signal is affected and what level is being output.

The De-Esser has the following controls:

– **Bypass**: Toggles this plug-in on and off.
– **Frequency Range**: Two controls let you target the frequency of the “s” sound for a particular speaker.
  – **Target Frequency**: A knob that lets you target the frequency of the offending sibilance. Sibilant sounds are usually found in the range of 5 - 8kHz.
  – **Range**: switches the operational mode of the De-esser. Three choices (from top to bottom) let you switch among Narrow Band, Wide Band, and All High Frequency which processes all audio above the source frequency.
– **Amount**: Adjusts the amount de-essing that’s applied.
– **Reaction Time**: Adjusts how suddenly de-essing is applied. There are three choices.
  – **Relaxed**: Equivalent to a slow attack.
  – **Fast**: Equivalent to a fast attack.
  – **Pre-emptive**: A “lookahead” mode.
De-Hummer

A repair plug-in with general applications to any recording. Eliminates hum noise that often stems from electrical interference with audio equipment due to improper cabling or grounding. Typically 50 or 60 cycle hum is a harmonic noise, consisting of a fundamental frequency and subsequent partial harmonics starting at twice this fundamental frequency.

A graph lets you see the frequency and harmonics being targeted as you adjust this plug-in’s controls.

De-Hummer has the following controls:

- **Bypass**: Toggles this plug-in on and off.
- **Listen to Hum only**: This checkbox at the top right lets you listen only to the hum that is being removed. This is very useful to determine if too much signal is being removed or if more hum attenuation can be applied.
- **Frequency**: Target source fundamental frequency. A knob lets you make a variable frequency selection, while radio buttons let you select common frequencies that correspond to 50Hz/60Hz electrical mains that are the typical culprits for causing hum.
- **Amount**: Adjusts how much De-Hum extraction you want to apply.
- **Slope**: Adjusts the ratio of fundamental frequency to partial harmonics, the adjustment of which lets makes it possible for various kinds of hum to be targeted. For example, a value of 0 biases hum extraction towards the fundamental frequency, while a value of 0.5 gives equal extraction of all harmonics (up to 4), and finally a value of 1.0 targets the higher frequency partials.
Delay

An effects plug-in. A general purpose stereo delay effect, suitable for tasks varying from track doubling, to early reflection generation, through simple harmonic enhancement. Processes in stereo or mono, depending on the track it’s applied to.

A graph shows the timing and intensity of the echoes generated by this plug-in on each channel, and an Output meter displays the output level of the resulting signal.

Delay has the following controls:

- **Bypass**: Toggles this plug-in on and off.
- **Input mode**: (Only visible when Delay is inserted on a multi-channel track.) Lets you choose how multiple channels are input to the delay. Stereo sets separate Left and Right channels. Mono sums Left and Right to both channels. Left inputs the Left channel only, and Right inputs the Right channel only.
- **Filters**: Affects the proportion of frequencies that are included in the delay effect. When the Delay plug-in is inserted on a Mono Channel, the Left and Right sections are replaced with a single “Delay” section.
  - **Low Cut (Hz)**: A global High Pass filter.
  - **High Cut (Hz)**: A global Low Pass filter.
- **Delay**: Adjusts the timing of the delay.
  - **Left/Right Delay (ms)**: Delay time of each channel.
  - **Left/Right Feedback (%)**: Feedback % of the Left or Right channel back to itself.
    A negative value equates to % of feedback with a phase reverse from the original signal.
- **Feedback**: Controls for adjusting the amount of bleed between channels.
  - **High Ratio**: Adjusts the frequency of a damping filter for the feedback signal.
  - **Stereo Blend**: Adjusts the proportion of signal from Left and Right channel feedback which feeds into the opposite channel. When the Delay plug-in is inserted on a Mono channel, Stereo Blend control does not appear.
– **Output**: Controls for adjusting the final output from this plug-in.

– **Dry/Wet (%)**: A percentage control of the output mix of “dry” or original signal to “wet” or processed signal. 0 is completely dry, 100% is completely wet.

– **Output Level (dB)**: Adjusts the overall output level of the affected sound.

# Dialog Processor

The Dialog Processor chains together six different common audio processing operations inside of a single plug-in, each tuned to the specific needs of making adjustments to improve human speech. The specialized De-Rumble, De-Pop, De-Ess, Comp(ressor), Expander, and Excite controls each have a streamlined set of controls tailored to speeding up the types of common adjustments every dialog track uses.

![The Dialog Processor plug-in](image)

# Distortion

An effects plug-in. Creates audio distortion that’s useful for sound design and effects, ranging from simple harmonic distortion simulating an audio signal going through primitive or faulty electronics (such as bad speakers, old telephones, or obsolete recording technologies), all the way to mimicking an overdriven signal experiencing different intensities of hard clipping (think someone yelling through a cheap bullhorn, megaphone, or PA system). This plug-in includes soft tube emulation in the output stage.

An animated graph shows the results of adjusting the Distortion parameters of this plug-in, giving you a visualization of the kind of harmonic distortion, waveshaping, and clipping that will be modifying the signal as you make adjustments. Input and Output meters let you see how the levels are being affected.
Distortion has the following controls:

- **Bypass**: Toggles this plug-in on and off.
- **Filters**: Two filters let you simulate devices reproducing limited frequency ranges.
  - **LF Cut**: Low frequency distortion shaping.
  - **HF Cut**: High frequency distortion shaping.
- **Distortion**: Three sets of controls let you create the type and intensity of distortion you want.
  - **Mode buttons**: Switch the operational mode of distortion. The one to the left, Distortion, creates harmonic distortion. The button to the right, Destroy, is a more extreme polynomial waveshaper.
  - **Distortion**: Adjusts the amount of distortion that’s applied to the signal. Higher values distort more.
  - **Ceiling**: Adjusts the level of input signal that triggers clipping.
- **Output**: Controls for adjusting the final output from this plug-in.
  - **Dry/Wet (%)**: A percentage control of the output mix of “dry” or original signal to “wet” or processed signal. 0 is completely dry, 100% is completely wet.
  - **Output Level (dB)**: Adjusts the overall output level of the affected sound.
  - **Auto Level button**: Applies automatic compensation for gain added to the signal due to the distortion being applied. Having this button turned on prevents the signal from becoming dramatically and unexpectedly increased, while turning it off frees you to do what you want, if what you want is to hear a lot of distortion.
Echo

An effects plug-in. A classic Echo effect, simulating the reflection of sounds that occur with a delay after the direct sound is heard. Processes in stereo or mono, depending on the track it’s applied to.

A graph shows the timing and intensity of the echoes generated by this plug-in on each channel, and an Output meter displays the output level of the resulting signal.

Echo has the following controls:

- **Bypass**: Toggles this plug-in on and off.
- **Input Format**: (Only visible when Echo is inserted on a multi-channel track.) Lets you choose how multiple channels are input to the echo. Stereo sets separate Left and Right channels. Mono sums Left and Right to both channels. Left inputs the Left channel only, and Right inputs the Right channel only.
- **Filters**: Alters the proportion of frequencies that are included in the delay effect. When the Delay plug-in is inserted on a Mono Channel, the Left and Right sections are replaced with a single “Delay” section.
  - **Low Cut (Hz)**: A global High Pass filter.
  - **High Cut (Hz)**: A global Low Pass filter.
  - **Feedback**: Adjusts the frequency of a damping filter for the feedback signal.
- **Left Channel**: Parameters that independently affect delay on the Left Channel. When the Echo plug-in is inserted on a Mono Channel, the Left Channel and Right Channel sections are replaced with a single “Echo” section with only the Delay Time, Feedback Delay, and Feedback controls.
  - **Delay Time**: Global Delay time for the Left Channel.
  - **Feedback Delay**: Echo Delay time for the Left Channel.
  - **Feedback**: Feedback percentage of the Left channel back to itself.
  - **L > R Feedback**: Percentage of Left feedback signal which feeds back to Right Channel.
- **Right Channel**: Parameters that independently affect delay on the Right Channel.
  - **Delay Time**: Global Delay time for the Right Channel.
  - **Feedback Delay**: Echo Delay time for the Right Channel.
  - **Feedback**: Feedback percentage of the Right channel back to itself.
  - **R > L Feedback**: Percentage of Right feedback signal which feeds back to Left Channel.
– **Output**: Controls for adjusting the final output from this plug-in.
– **Dry/Wet (%)**: A percentage control of the output mix of “dry” or original signal to “wet” or processed signal. 0 is completely dry, 100% is completely wet.
– **Output Level (dB)**: Adjusts the overall output level of the affected sound.

Flanger

An effect plug-in, giving that unmistakable Flanger sound dating from the days of dual tape machines with a slight delay added to one in periodic intervals causing flanging as they got back in sync with one another. Typically used to add a sort of warbling harmonic interest to a signal, in a wide variety of ways.

An animated graph shows the results of adjusting the Modulation parameters of this plug-in, giving you a visualization of the kind of warble that will be added to the signal as you make adjustments.

The Flanger has the following controls:

– **Bypass**: Toggles this plug-in on and off.

– **Input mode**: (Only visible when the Flanger is inserted on a multi-channel track.) Lets you choose how multiple channels are input to the Flanger. Stereo sets separate Left and Right channels. Mono sums Left and Right to both channels. Left inputs the Left channel only, and Right inputs the Right channel only.

– **Modulation**: A low frequency oscillator (LFO) used to drive the Flanger effect.
– **Waveform (Hz)**: Specifies the shape of the LFO that modulates the rate of the Flanger. The three choices are Sine (a smooth change in rate), Triangle (a jerky change in rate), and Sawtooth (an abrupt change in rate). Affects the timing of the warble that is added to the sound.
– **Rate (%)**: Speed of the LFO, affects the speed of the warble that is added to the sound. Low rate values create a slow warble, while high rate values create more of a buzz.
– **Depth**: Affects the “length” of the warble that is added to the sound. Low values add only the very beginning of a warble, high values add more fully developed warble.
– **Width**: Consists of a single parameter, Expansion, which sets Left/Right channel length differences, along with the phase offset of modulators.
Feedback: These controls determine, in large part, how extreme the Flanging effect will be.

- Amount (%): The percentage of signal fed back to the Delay Line. Values can be positive or negative, the default is 0 (no effect). Increasing this parameter adds more of the Flange effect to the signal, lowering this parameter adds more of the inverted Flange effect to the signal. At values closer to 0, only a faint phase shift can be heard in the audio, but at values farther away from 0 (maxing at +/- 99), a gradually increasing warble becomes audible. The type of warble depends on the Modulation controls.

- High Ratio: Determines the attenuation of the echo over time.

Output: Controls for adjusting the final output from this plug-in.

- Dry/Wet (%): A percentage control of the output mix of “dry” or original signal to “wet” or processed signal. 0 is completely dry, 100% is completely wet.

- Output Level (dB): Adjusts the overall output level of the affected sound.

Foley Sampler

The Foley Sampler is a built-in sampler that makes it easy to add sound effects that you want to play using a keyboard, pad, or other MIDI performance device connected to your computer, to add timed sound effects to sync with onscreen visuals. This plug-in has been designed to simplify the process of recording performed audio cues on the current track to which the sampler has been added.

Setting Up the Foley Sampler

Using the Foley Sampler to record samples played with a MIDI controller is easy.

1. Create an audio track you want to record sound effects or instruments to.
2. Drag the Foley Sampler onto the track header to assign it to that track. The Foley Sampler window automatically appears. The Fairlight page knows this is an instrument with no inputs to the plug-in, so this effect is automatically patched to that track’s input, ready for recording.
3. If you have a MIDI controller of some kind connected to your computer and properly configured, it will appear in the MIDI drop-down menu at the upper-right corner of the Foley Sampler window (next to the Keyboard button). Choose your device from this menu, and the Keyboard button will highlight to show it’s enabled.

At this point, the Foley Sampler is ready to be used, but by default it has no samples loaded to play. The next step is to add sound effects.

Adding Sound Effects

You can add prerecorded sound effects or instruments to the Foley Sampler in the following ways:

- Drag and drop an audio file in a supported format from the file system onto the Foley Sampler window
- Drag and drop a sound effect from the Sound Library onto the Foley Sampler window
- Click the Foley Sampler window’s Option menu and input sounds from your attached drives.

Once you’ve loaded a sound effect of some kind, it’s automatically mapped to the top four keys of your instrument, starting at C2. Pressing a key or pad of your controller will play that sound.

If you want to see the sound’s waveform, you can click the Sample button at the top of the Sound panel. In this example, there are a series of continuous footsteps recorded in a row that we can use.
Splitting Sound Effects

It’s common to use pre-recorded library sound effects that consist of a series of recorded footsteps, cloth rustles, punches, or other “foleyed” sound recordings, in order to play variations of a specific kind of repetitive sound effect in sync to action that’s happening on screen. The Foley Sampler lets you do this easily.

1. After you’ve loaded a sound effect, click the Foley Sampler window’s Option menu and choose Split Sample to automatically split the current sample into slices based on an analysis of its noise floor, and assign each slice to a set of keys or pads on your selected MIDI device. Continuing with the previous example, each footstep has been split and assigned to a different key.

2. To adjust the timing of each slice of the sound effect that’s been split apart, you can click on the assignment text above the keyboard at the bottom of the window to see that slice in the Sample view.

3. You can adjust the Range Start and Range End parameters to encompass as much or as little of that slice as you want to play back.

4. If you want a sample to loop if a note is held down, you can enable the Loop button, and then adjust the Loop Start and Loop End parameters to choose how much of each slice will loop.

5. To delete slices that aren’t useful, you can select a slice you don’t like and press Shift-Delete to clear that slice from the virtual keyboard.
Assigning Sound Effects Manually

When you first load sound effects into the Foley Sampler, they're automatically assigned to a series of notes. Each additional sound effect that you load is automatically assigned to the next series of notes to the right. Once all notes are occupied, additional sound effects will shuffle all previous assignments to the left.

You also have the option of manually assigning sound effects that you load. This is useful when you want to manually load a variety of different sound effects all at once (such as a combination of punch sounds, human grunts, and cloth rustles to use in a fight scene), and assign them to particular notes of your choosing.

1. Load a sound effect you want to map.
2. Click the Mapping button to remap the range of notes it corresponds to.
3. Use the Low and High parameters to select a range of notes for the selected sound.
4. You also have the option of tuning the pitch of specific sound effects, if necessary.
Adjusting Sound Effects

If you want to customize a sample or slice further, you can select it above the virtual keyboard and use the controls on the Level panel to control the dynamics of audio playback, or you can use the controls on the Filter panel to EQ the sound.

**TIP:** If a sample or slice is set to loop, you can press the Control key and click a key on the virtual keyboard to initiate looping, so you can hear these adjustments as you’re making them.

Playing and Recording Sound Effects

Once you’ve set up the Foley Sampler with sound effects you can play from a MIDI controller, recording those sound effects is simple.

1. Make sure that the “Save clips to” field in the Capture and Playback panel of the Project Settings is correctly set up to record to the desired storage volume, using the Browse button, if necessary.

2. Click the R button in the track header of the audio track to which you applied the Foley Sampler, to put that track into Record Enable mode.

3. Click the Record button in the Fairlight toolbar.

4. While Fairlight records, use the keys or buttons of your MIDI controller to play sounds in sync to the picture on your display. When you’re done, click the Stop button.

You should now have a recorded clip containing the sound effects you played, in sync to the picture. If they’re a bit out of sync, you can always use the Elastic Wave audio retiming controls to tighten the sync without re-recording everything.

A new clip of audio created by recording sounds played via the Foley Sampler
Frequency Analyzer

This lets you see a visualization of the levels across all frequencies of a clip or track. A Mode drop-down lets you choose to see the full audible spectrum, or to restrict the visualization to low, medium, or high frequencies.

![The Frequency Analyzer plug-in](image)

LFE

A low-pass filter that you can apply to a main that’s in a surround sound format, to feed low-frequency sound to an LFE channel as part of a surround sound mix. If there is no LFE channel available, this plug-in does nothing. A Frequency control lets you choose which low frequency range you want to include, and a Trim control lets you set the level of the resulting LFE channel.

![The LFE plug-in](image)
Limiter

A true peak limiter that is capable of looking 64 samples ahead of the input, in order to limit the audio in a very smooth fashion. An Input control lets you adjust the level of the incoming signal, while Threshold and Release controls let you adjust the limiting that’s being done. A graph shows you an analysis of the audio as it’s processed, with a visual indication of what parts of the signal are being affected by this plug-in.

![The Limiter plug-in](image)

Meter

A sample peak processing meter that’s useful for temporarily adding a meter to a specific track, Sub, Aux, or Main. These meters are useful for instances where you want a large meter that focuses on a specific bus while you’re working.

These meters are presented very simply, with a gray bar indicating level and a red peak line that holds for two seconds, which indicates the highest peak. A numeric reading at the top of the meter gives the exact level, in dB. This number continues to hold, indicating the loudest level measured for any given stretch of playback.

![The Meter Fairlight FX](image)
Meter has the following controls, all located in the option menu:

- **Width**: Lets you resize the width of the meter window. Options are: Narrow, Normal, and Wide.
- **Height**: Lets you resize the height of the meter window. Options are: Small, Medium, and Large.
- **Reset Peak on Play**: When enabled, the numeric peak level is reset every time playback stops and starts again. When disabled, the numeric peak level persists until changed by a higher peak.
- **Reset**: Resets the numeric peak level.

## Modulation

An effect plug-in. General purpose modulation plug-in for sound fx/design. Four effects combine an LFO, FM adjustment, AM adjustment, Sweep and Gain filters to allow simultaneous frequency, amplitude and space modulation. In conjunction with the Rotation controls, simple Tremelo and Vibrato effects can be combined with auto-filter and auto-Pan tools in order to provide texture and movement to a sound.

An animated graph shows the results of adjusting the Modulator, Frequency, and Amplitude parameters of this plugin, giving you a visualization of the kind of modulations that will be applied to the signal as you make adjustments. Output meters let you see what level is being output.

![Modulation Fairlight FX](image)

Modulation has the following controls:

- **Bypass**: Toggles this plug-in on and off.
- **Modulator**: A low frequency oscillator (LFO), shown in blue in the animated graph.
- **Shape**: Specifies the shape of the LFO waveform that modulates the audio. Six options include Sine, Triangle, Saw1, Saw2, Square, Random.
- **Rate (Hz)**: Adjust the speed of the modulating LFO. Lower settings result in warbling audio, while extremely high settings result in buzzing audio the timbre of which is dictated by the shape you’ve selected.
– **Frequency:** Frequency modulation (FM) of a secondary oscillator, shown as green in the animated graph.

  – **Level (%):** Acts as a Dry/Wet knob controlling the amount of Frequency Modulation that’s applied, intensifying or easing off the effect.

  – **Phase:** Since each of the four primary effects within this plug-in can be applied together, along with the fact that modulation with level components (Tremelo/Rotation/Filter) have the ability to combine or cancel out one another, phase controls are available. Altering the phase of an individual effect allows control of such interaction (e.g., cancel out a high level change, or offset a cancellation).

– **Filter:** Sweep and gain filters.

  – **Level:** Acts as a Dry/Wet knob controlling the amount of filter sweep and gain to additionally use to modify the signal. The amount you’ve selected is previewed in a 1D graph to the side.

  – **Tone:** Adjusts the center frequency of sweep.

  – **Phase:** Since each of the four primary effects within this plug-in can be applied together, along with the fact that modulation with level components (Tremelo/Rotation/Filter) have the ability to combine or cancel out one another, phase controls are available. Altering the phase of an individual effect allows control of such interaction (e.g., cancel out a high level change, or offset a cancellation).

– **Amplitude:** Amplitude modulation (AM) of a secondary oscillator, shown as green in the animated graph.

  – **Level:** Acts as a Dry/Wet knob controlling the amount of Amplitude modulation applied. (Disabled in Ring Modulation Mode.)

  – **Phase:** Since each of the four primary effects within this plug-in can be applied together, along with the fact that modulation with level components (Tremelo/Rotation/Filter) have the ability to combine or cancel out one another, phase controls are available. Altering the phase of an individual effect allows control of such interaction (e.g., cancel out a high level change, or offset a cancellation).

  – **Ring Modulation Mode:** Enables a Ring Modulation effect (where the signal is multiplied by the modulator, rather than modulated by it).

– **Rotation:** These controls are only available when applied to a multi-channel track.

  – **Depth:** Amount of Rotation applied.

  – **Phase:** Since each of the four primary effects within this plug-in can be applied together, along with the fact that modulation with level components (Tremelo/Rotation/Filter) have the ability to combine or cancel out one another, phase controls are available. Altering the phase of an individual effect allows control of such interaction (e.g., cancel out a high level change, or offset a cancellation).

  – **Offset:** Start offset of rotation in order to further place the signal in space.

– **Output:** Controls for adjusting the final output from this plug-in.

  – **Dry/Wet (%):** A percentage control of the output mix of “dry” or original signal to “wet” or processed signal. 0 is completely dry, 100% is completely wet.

  – **Output Level (dB):** Adjusts the overall output level of the affected sound.
Multiband Compressor

A dynamics processor that compresses in highly definable frequency bands. The graph displays frequencies in Hertz horizontally and gain in decibels vertically.

The default setting of the Multiband Compressor

Each band has dynamics control in the determined frequency ranges of Low, Med, and High and are adjustable by pushing the intersection mark on the graph per band or by typing in a frequency.

- **Bands 1 – 4**: Controls for each band.
  - **Threshold**: Sets the maximum allowable output level. The default is –25dB. The range is from –50 to 0dB.
  - **Gain**: Can add or attenuate up to 12dB of gain.
  - **Ratio**: Adjusts the compression ratio. This sets the gain reduction ratio (input to output) applied to signals that rise above the threshold level. The default is 1.5:1. The range is 1.0:1 to 7:1.
  - **Limit**: Limits the output amount by up to 15dB. The default is 4.5dB.
  - **Attack**: Adjusts the attack rate time constant of the sidechain detector. The default is 1.4mS. The range is 0.1 to 100mS.
  - **Hold**: Keeps dynamics from being triggered again until a certain amount of time has passed, in mS (milliseconds). Defaults to 0mS. The range is from 0 to 4000mS.
  - **Release**: Adjusts how quickly the sidechain detector stops applying dynamics when a signal goes back below the threshold. The default is 150mS. The range is 50mS to 4.0S.

- **Master**: Controls for adjusting the final output from this plug-in.
  - **Gain (dB)**: Adjusts the overall output level of the affected sound by adding or reducing 18dB of gain.
  - **Q**: Adjusts the width of affected frequencies. Lower values include a wider range of frequencies, higher values include a narrower range of frequencies.
**Noise Reduction**

A repair plug-in designed to reduce a wide variety of noise in all kinds of recordings. A graph shows a spectral analysis of the audio being targeted, along with a purple overlay that shows what noise is being targeted. Two audio meters let you evaluate the input level (to the left) versus the output level (to the right), to compare how much signal is being lost to noise reduction. There are three default presets: De-Hiss, De-Rumble, and De-Rumble and Hiss.

![The Noise Reduction Fairlight FX in action](image)

Noise Reduction has the following controls:

- **Bypass**: Toggles this plug-in on and off.

- **Listen to Noise Only**: This checkbox at the top right lets you listen only to the noise that is being removed. This is very useful to determine if too much signal is being removed or if more noise attenuation can be applied.

- **Threshold (in dB)**: Relates to the signal-to-noise ratio (SNR) in the source recording. Recordings with a poor signal-to-noise ratio will require a higher threshold value, resulting in more noise reduction being applied.

- **Attack (in ms)**: Primarily useful in Auto Speech mode, this controls the duration over which the noise profile is detected. Ideally, the attack time should match the variability of the unwanted noise. A low value corresponds to a faster update rate of the noise profile and is useful for quickly varying noise; a high value corresponds to a slower update rate and can be used for noise that’s more consistent.

- **Sensitivity**: Higher sensitivity values exaggerate the detected noise profile; the result is that more noise will be removed, but more of the dialog you want to keep may be affected.

- **Ratio**: Controls the attack time of the signal profile relative to the attack time of the noise profile. A faster ratio detects and preserves transients in speech more easily, but the resulting speech profile is less accurate.

- **Frequency Smoothing**: Smooths the resulting signal in the frequency domain to compensate for harmonic ringing in the signal after the noise has been extracted.

- **Time Smoothing**: A toggle button enables smoothing of the resulting signal in the time domain as well.
– **Dry/Wet**: A percentage control of the output mix of “dry” or original signal to “wet” or processed signal. 0 is completely dry, 100% is completely wet.

– **Makeup Gain**: To let you compensate for level that may be lost due to the noise reduction operation you’re applying, this applies a pre-gain in, from -6dB to +18dB, just before the dry/processed mix.

### Phase Meter

Phase cancellation is a phenomena where the waveforms of a stereo recording (for example a stereo recording of a music performance) go slightly out of sync with one another for whatever reason, and begin to cancel one another out in unpredictable ways, resulting in the audio sounding strange. This results in poor quality audio and can cause problems when you’re trying to compress a mix to a distribution format such as AAF or MP3.

The Phase Meter plug-in is a visual meter that lets you evaluate whether or not a signal is in phase and is meant to be applied to a bus so you may evaluate the phase of a mix and correct whatever problems may be occurring. The position of a green dot within a horizontal meter indicates the phase of the signal. When there’s no signal or a signal on only one half of a stereo bus, the dot appears in the center (0). When the signal is out of phase, the dot appears all the way to the left (-). When the signal is in phase, the dot appears all the way to the right (+).

![Phase Meter plug-in](image)

### Pitch

An effects plug-in that shifts audio pitch without altering clip speed.

Pitch has the following controls:

– **Bypass**: Toggles this plug-in on and off.

– **Semitones**: A “coarse” adjustment that can shift audio pitch up to +/- 12 semitones.

– **Cents**: A “fine” adjustment that can tune audio pitch in +/- 100ths of a semitone.

– **Dry/Wet**: A percentage control of the output mix of “dry” or original signal to “wet” or processed signal. 0 is completely dry, 100% is completely wet.
Reverb

A spatial simulation plug-in, capable of recreating multichannel reverberation corresponding to rooms of different sizes, adjustable via a graphical 3D cube control. This plug-in lets you take a “dry” recording and make it sound as if it’s within a grand cathedral, an empty room, a tiled bathroom, or other spaces.

To understand this plug-in’s controls, it helps to know that the signal follows three paths which are combined to create the final effect:

– A direct path.
– An early reflection path (ER) simulating early reflection rays obtained from the first multiple reflections on the walls, traveling from the virtual source to the virtual listener.
– A late reverberation path (Reverb) simulating the behavior of an acoustic model of the room.

A graph shows an approximate visualization of the reverb’s effect on the frequencies of the audio signal.

Reverb has the following controls:

– **Bypass:** Toggles this plug-in on and off.
– **Room Dimensions:** By controlling the size of the virtual room a sound is to inhabit, these parameters simultaneously control the configuration of Early Reflection and Late Reverberation processing. The acoustic modes from this simulated room are computed and fed to Late Reverberation processing. The shape, gain, and delay of the first reflections are computed and then fed to Early Reflection processing.
– **Height, Length, Width:** Defines the dimensions of the reverberant space, in meters.
– **Room Size:** The calculated Room Width x Length, in meters².
- **Reverb**: Additional controls that further customize the configuration of Early Reflection and Late Reverberation processing.

- **Pre Delay**: Increase or negate the propagation time from the virtual source to the virtual listener. As a result, it modifies the initial delay time between the source signal and the first reflection.

- **Reverb Time**: Decay time of the Reverb tail. It controls the overall decay time of the acoustic modes from late reverberation processing.

- **Distance**: Modifies the distance between the virtual source and the virtual listener. It modifies only the configuration of early reflections processing.

- **Brightness**: Modulate the shape of the decay time over frequency. At maximum brightness, decay time is identical at any frequency. At minimum brightness, higher frequencies result in shorter decay time and therefore duller sound.

- **Modulation**: Adds random low-frequency phase modulation from the tapping point of ER processing. At 0%, modulation is not used.

- **Early Reflection Tone**: Four post equalization controls modify the tone of early reflections to suit a particular room’s characteristics.

  - **Low Gain**: Amount of gain added to the low frequency.
  
  - **Low Frequency**: Frequency range of 150 Hz to 500 Hz.
  
  - **High Gain**: Amount of gain added to the high frequency.
  
  - **High Frequency**: Frequency range of 1k Hz to 16k Hz.

- **Reverb Tone**: Four post equalization controls modify the tone of the reverb tail to suit a particular room’s characteristics.

  - **Reverb Tail Low Gain**: Amount of gain added to the low frequency.
  
  - **Reverb Tail Low Frequency**: Frequency range of 150 Hz to 500 Hz.
  
  - **Reverb Tail High Gain**: Amount of gain added to the high frequency.
  
  - **Reverb Tail High Frequency**: Frequency range of 1k Hz to 16k Hz.

- **Output**: These controls recombine the three audio processing paths into a single output signal.

  - **Dry/Wet**: A percentage control of the output mix of “dry” or original signal to “wet” or processed signal. 0 is completely dry, 100% is completely wet.
  
  - **Direct Level**: The amount of the direct level to mix into the final signal.
  
  - **Early Reflection Level**: The amount of early reflection to mix into the final signal.
  
  - **Reverb Level**: The amount of reverb to mix into the final signal.

---

**Soft Clipper**

The Soft Clipper is a limiting processor that reduces the output level above a defined threshold in a rounded manner so that peaks are more cleanly attenuated. The Soft Clipper plug-in will impart saturation effects when pushed hard above the threshold, allowing for the introduction of warmth and subtle distortion to the sound. A graph shows the shape of the curve adjustment this plug-in makes to the audio.

A soft clipper is often combined with a standard limiter in order to increase perceptual loudness of material without imparting harshness.
The Soft Clipper Fairlight FX

- **Threshold**: Introduces input gain to the signal prior to hitting the clipper, forcing audio peaks over the threshold by that amount. As such, it will drive the saturation and distortion.

- **Shape**: The shape of the clipper can be varied to change the character of the soft clipper from full soft-clipping (all the way right, where the peaks are rounded) to full hard-clipping (all the way left, where the peaks are squared off).

- **Output Level**: Lets you adjust the output gain to compensate for signal lost during soft clipping, if necessary.

**Stereo Fixer**

A simple plug-in designed to fix stereo source material in cases where only one side of a stereo signal was recorded, where one side of a stereo recording is a different level to the other, or where the stereo channels have been incorrectly Left/Right swapped.

This plug-in can also be used as a “Mid/Side” decoder, for recordings that were made using this microphone technique.

This plug-in is for stereo clips only.
– **Format**: The input processing mode you want to use to fix the stereo output.
– **Stereo**: (Default) No format conversion is performed.
– **Reverse Stereo**: Swaps the Left and Right side.
– **Mono**: The output from the plug-in is a mono mix of the two inputs.
– **Left Only**: The left input is sent to both left and right outputs.
– **Right Only**: The right input is sent to both left and right outputs.
– **M/S**: The left output is the left (Mid) input minus the right input (Side). The right output is the left (Mid) input plus right input (Side).

– **Left/Right Gain**: Lets you apply independent gain on the left or right outputs. This gain is applied after (post) the input processing mode.

**TIP**: For a comprehensive M/S decoder solution, simply chain two Stereo Fixer plug-ins together. Use the first unit to control the Side signal level, thus controlling the width of the second unit (set to M/S).

### Stereo Width

An enhancement plug-in that increases or reduces the spread of a stereo signal in order to widen or reduce the separation between channels. If this plug-in is added to a Mono channel, it will be disabled, as there is no stereo width to either distribute or control.

A graph shows the currently selected width of stereo distribution as a purple arc, while inside of that graph a stereo meter shows the Left and Right distribution of the audio signal. Two audio meters measure levels, an Input meter to the left, and an Output meter to the right.

![The Stereo Width Fairlight FX in action](image)

Stereo Width has the following controls:

– **Width**: Lets you control the spread of the stereo output. Settings range from 0 (Mono) to 1 (Stereo) to 2 (extra wide stereo).
– **Diffusion**: Adds more complexity to the output.
– **Sparkle**: Adds more high frequencies to the spread.
Surround Analyzer

The Surround Analyzer is a graphical meter that shows a spatial image of the audio being measured, rather than a typical bar graph meter. Due to its changing shape because of the signal being played, sometimes it is referred to as the “jellyfish meter.”

This type of metering is very useful; rather than relying on bars to indicate the directions in which audio is radiating, you can clearly see the relationship of all of the channels to one another.

Vocal Channel

An enhancement plug-in for general purpose vocal processing consisting of High Pass filtering, EQ, and Compressor controls.

Side by side EQ and Dynamics graphs are presented above the controls. An output audio meter lets you monitor the final signal being produced by this plug-in.
Vocal Channel has the following controls:

- **High Pass**: Enabled by a toggle, off by default. Has a single frequency knob that sets the threshold below which frequencies are attenuated to reduce boominess or rumble.

- **EQ**: A three-band EQ for fine tuning the various frequencies of speech, enabled by a toggle, including Low, Mid, and High Mode, Frequency, and Gain controls
  - **Low/Mid/Hi Mode**: Lets you choose from different filtering options to use for isolating a range of frequencies to adjust. Different bands present different options.
  - **Low/Mid/Hi Freq (Hz)**: Lets you choose the center frequency to adjust.
  - **Low/Mid/Hi Gain (dB)**: Lets you boost or attenuate the selected frequencies.

- **Compressor**:
  - **Thres (dB)**: Sets the signal level below which compression occurs. Defaults to -25dB. The range is from -40 to 0dB.
  - **Reaction**: Adjusts how quickly compression is applied when a signal exceeds the threshold. The default is 0.10.
  - **Ratio**: Adjusts the compression ratio. This sets the gain reduction ratio (input to output) applied to signals which rise above the threshold level. The default is 1.5:1. The range is 1.1 to 7.0.
  - **Gain (dB)**: Lets you adjust the output gain to compensate for signal lost during compression, if necessary.
Audio Meters and Audio Monitoring

The Meters panel, which appears at the top of the Fairlight page when it’s enabled, provides a visual reference of the levels of each track in your mix, along with specialized meters showing the buses, monitoring mix, loudness, and a Viewer for seeing the video of the current project as you work. This chapter describes the use of these meters, and provides information about the different options that are available.

Contents

The Monitoring Panel 3333
Track Meters and Monitoring Controls 3333
Using Post Fader or Track Source Meters 3334
Bus Meters 3334
Meter Plug-in 3335
Surround Analyzer 3335
Compound Meters and Output Bus Selection Menu 3336
Monitoring Menus 3336
Control Room Meters 3337
Loudness Meters 3337
Offline Loudness Analyzer 3339
Viewer 3341
Cinema Viewer on Fairlight Page 3341
The Monitoring Panel

Turning on the meters in the UI toolbar displays the Monitoring panel that runs along the top of the Fairlight page, which shows all of the audio meters that correspond to the tracks in the Timeline, as well as the Bus meters that correspond to the Mains, Subs, and Aux buses of your mix, the Control Room meters, and a video viewer.

Double-clicking anywhere on the Tracks panel of the meters hides or reveals a double-height Track display. With the increased track counts necessary for immersive audio, the extra metering allows you to see more tracks display in real time.

Track Meters and Monitoring Controls

At left, a row of audio meters corresponds to the channel strips of the Mixer, one meter for every audio track in the timeline. Each track displays the number of meters that corresponds to that track’s audio mapping, with mono tracks having a single audio meter, stereo tracks having two, 5.1 tracks having six, and so on.

Each track and bus meter (with the exception of the Loudness meters) display RMS (root mean square) levels against a dB scale. A single line indicating the maximum value at any given moment in time is
held briefly just above the current RMS levels, which appear as a solid bar extending from the bottom of the meter. RMS meters display a weighted “average” representation of the audio level that’s closer to the way audio is actually perceived, although not as accurate as the loudness meters discussed later in this section.

Each meter bar is color coded to indicate three different thresholds of sound level, from low (green) to high (yellow) to very high (red).

Each meter is identified by the track number it represents (track names are not shown over track meters) as well as the color of that track.

**Using Post Fader or Track Source Meters**

The Track Meters setting in the Fairlight tab of the Project Settings lets you choose how meters in the Fairlight page display their audio analysis. There are two options:

- **Post Fader:** Meters always display the level of each clip’s signal after whatever fader adjustments have taken place. Fading a track’s level down diminishes the visible level of that audio signal in the meter. This setting is good if you prefer a visual indication of the relative levels you’ve set your various audio tracks to, which is a very NLE-oriented behavior.

- **Track Source:** Meters always use the volume levels of the audio clips in that track, even if you’ve lowered the level using the sliders. If you’ve keyframed a clip’s volume, that change will be reflected by the audio meters, even though fader changes are not. Viewing meters this way means you can always see how much level is available to clips in your mix regardless of what the current fader levels are set to, in the event you want to keep track of audio you want to bring back into the mix later on. This is typically referred to as pre-fader metering.

**Bus Meters**

To the right of the track meters are the bus meters, in which all user-created Mains and buses appear, separated by type, and each displaying the number of meters that corresponds to that track’s audio mapping. This way you can see the sum of all tracks that have been routed to a particular bus.
Meter Plug-in

There is a Meter plug-in available for temporarily adding a meter to a specific track, Sub, Aux, or Main. These are sample peak processing meters that are useful for instances where you want a large meter that focuses on a specific bus while you’re working.

These meters are presented very simply, with a gray bar indicating level and a red peak line that holds for two seconds, which indicates the highest peak. A numeric reading at the top of the meter gives the exact level, in dB. This number continues to hold, indicating the loudest level measured for any given stretch of playback. The option menu in this meter’s floating window presents different settings you can choose. For more information, see Chapter 177, “Fairlight FX.”

Surround Analyzer

The Surround Analyzer is a graphical meter that shows a spatial image of the audio being measured, rather than a typical bar graph meter. Due to its changing shape because of the signal being played, sometimes it is referred to as the “jellyfish meter.”

This type of metering is very useful; rather than relying on bars to indicate the directions in which audio is radiating, you can clearly see the relationship of all of the channels to one another.
Compound Meters and Output Bus Selection Menu

The compound meters, to the right of the bus meters, consist of Control Room meters and Loudness meters, shown side-by-side to provide a comprehensive analysis of your overall audio mix. Below, drop-down menus let you choose which bus you want to monitor, as well as which set of speakers you want to use to do the monitoring.

The Control Room meters (at left), and Loudness meters (at right)

Monitoring Menus

The monitoring menus determine which bus gets analyzed by the compound meters. When the compound meters are displayed, the Monitoring drop-down menu that otherwise appears to the left of the monitoring controls in the Transport toolbar instead moves to a position underneath the Loudness meters.

This drop-down menu lets you choose which bus you want to monitor as you work. You can choose one of your mains, or you can choose a Sub or an Aux that you want to focus on for more detailed work.

The monitoring menu lets you choose which bus you want to monitor while working

The next drop-down menu to the right lets you choose one of the available sets of speakers once you’ve configured them in the Video and Audio I/O panel of the System Preferences. This gives you the flexibility to quickly listen to your mix on a variety of speakers and configurations to see how it holds up in different situations. For more information on configuring different speaker setups, see Chapter 4, “System and User Preferences.”

The monitoring menu lets you choose which bus you want to monitor while working
Control Room Meters

The mustard-colored Control Room audio meters show the sum of all audio channels that are routed to the currently selected bus being monitored (as selected in the drop-down menu below). These are peak meters measured in dBFs.

A true peak audio measurement is displayed at the top of the Control Room meter.

Loudness Meters

The set of meters all the way to the right are the Loudness meters, which consist of a set of two graphical meters and a numerical readout. These meters let you analyze the “integrated loudness” of the overall mix, which is the standard to which all contemporary mixing specifications refer when describing the deliverables you’re expected to provide to the client. Unlike the RMS audio meters found in the Timeline or mixer which measure audio in dB, loudness meters do a different kind of analysis, measured in LU (loudness units).

What Is LU?

A value of 1 LU (loudness unit) represents the smallest difference in audio levels that humans can actually perceive. Human hearing naturally sums all channels that reach the ear, so the summed channel meter to the right in the compound meters is an analysis of the loudness you actually hear.

Loudness Meter Options

Two options in the General Options of the Project Settings let you customize the Loudness meters.

– **Target Loudness level**: Lets you set the LUFS value that’s used as a reference level for loudness metering. Defaults to –23 LUFS, which conveniently makes the display of these meters scale similarly to traditional audio meters that you’re already used to.

– **Loudness Scale**: Lets you choose which scale you want to use with which to measure the meters. Options currently include the default of EBU +9 Scale (–18 to +9), and EBU +18 Scale (–36 to +18).

Support for Multiple Loudness Standards

The Loudness Meter can be switched among a variety of international industry-standard loudness monitoring standards. The standard you choose uses the integrated loudness value (along with a specified tolerance defined by each selected standard) to indicate whether or not the current mix level is of acceptable loudness via color coding of the Integrated Loudness value, and in the Integrated Loudness graph described below. Blue values indicate loudness levels that are below tolerance, yellow indicates loudness values that are within tolerance, and red indicates loudness values that are above tolerance.

The built-in standards you can switch among include the following:

– **BS.1770-1**: An older loudness standard used by DaVinci Resolve version 15 and before.

– **BS.1770-4**: The most up-to-date loudness standard as of DaVinci Resolve 16; the algorithms specified by this standard govern the other standards that are listed below in this drop-down menu.

– **ATSC A/85**: The American standard for acceptable loudness in broadcast.

– **EBU R128**: The European standard for acceptable loudness in broadcast.

– **OP-59**: The New Zealand and Australian standard for acceptable loudness in broadcast.

– **TR-B32**: The Japanese standard for acceptable loudness in broadcast.

– **AGCOM 219**: The Italian standard for acceptable loudness in broadcast.

– **NETFLIX**: The Netflix standard for acceptable loudness in broadcast.
All of these loudness standards are available for off-line readings as well, using the Loudness Analyzer described in the next section.

**NOTE:** The target peak meter now uses the BS.1770-4 standard for measuring maximum "true peak," which means that this meter is capable of measuring "inter-sample peaks," rather than only the peaks at each sample of a waveform.

**Graphical Loudness Meters**

Two separate meters give you a dynamic graphical measurement of the loudness of the selected bus being monitored according to the loudness standard you’ve selected, which determines how to analyze the subjective loudness of a given audio mix for purposes of compliance with required broadcast quality control (QC) standards.

- A steel-blue meter labeled M (for momentary) has as many channels as the selected bus you’re monitoring, excluding the LFE channel(s) of surround formats, which aren’t factored into loudness metering. This meter measures LEQ (equivalent sound level), within a 400ms window following the playhead as measured every 100ms. This lets you evaluate the LUFS (Loudness Units Full Scale) level of the mix at the current frame as you play. This discrete-channel analysis is used to calculate all other values of the loudness metering system.

- A second steel-blue mono meter to the right displays the sum of all channels in the M meter, displayed in LU (loudness units). The number value displayed at the top of this meter is the maximum LU value that’s been analyzed during any stretch of timeline playback. This value is held until it’s reset, either by stopping and initiating playback a second time while Link to Playhead is enabled, or when you click the Reset button at the bottom of the loudness meter area.

**Numeric Loudness Meters**

A set of values to the right of the meters give running reports on the audio level of your mix. While the graphical meters are useful for analyzing your mix as you work, these numeric readouts are particularly valuable for providing the strict information you need to adhere to written QC standards. Their meaning is as follows:

- **Short:** Measures the average LU level over a 30-second window following the playhead.

- **Short Max:** Shows the maximum level over the same 30-second window. This analysis is required by EBU R128.

- **Range:** Measures the dynamic range of the Loudness of your mix (in LU), which is the difference between the average soft and average loud parts of your mix. Analyzes the overall loudness over a played range of the mix, discounts the lowest 10% and highest 5%, and then gives a standardized expression of the difference between the remaining soft and loud levels that were analyzed. The window of analysis is as long as you’ve been playing. This analysis is required by most QC specifications.

- **Integrated:** Measures the LUFS value of the portion of the range of the mix you’ve played through. As you play, this integrated value accumulates. This analysis is required by most QC specifications.

**Absolute Scales and Dialog**

While some users prefer to measure their levels to correspond to a relative scale of "0," similar to a VU meter where the needle rides above the "0," others want to see the absolute measure of the amplitude in LUFS and true peak. By default, the Loudness meter is set to relative scale, but you now have the option to choose between relative scale and absolute scale in the Loudness meter.

Relative scale in the Loudness menu is relative to the selected scale, so a loudness unit of 0 corresponds to the target of the chosen measure type. For instance, if EBU R128 is selected, whose target measure is -23dB LUFS, the “0” LU (Loudness Unit) is -23dB. If ATSC A/85 is chosen, whose target is -24dB, then that becomes the corresponding equivalent of the relative LU of 0.
When using the absolute scale, the Loudness meter displays the increments to reflect the chosen measure type. In absolute scale, the EBU R128 meter will display -23 instead of the relative scale’s 0.

Using the Loudness Meters

When using the Loudness meters to do a structured analysis of your mix to determine QC adherence, a group of controls let you determine when analysis begins and ends.

- **Lock Metering to Transport**: This setting is found in the compound meter option menu. When enabled, all loudness metering analysis is automatically reset whenever you move the playhead to another location in the Timeline. This is useful when you’re spot-checking different parts of your mix, or working on a particular scene.

- **Absolute Scale**: An absolute measure of the selected scale type.

- **Pause and Reset buttons**: When you’re doing a formal analysis of your mix, the Reset button lets you reset all currently accumulated analyses, and the Start button initiates loudness value accumulation. If you need to stop playback briefly to do something else, you can click Pause, and then click Resume when you’re ready to continue the analysis.

Offline Loudness Analyzer

Users also have the ability to analyze an audio file’s loudness offline. This is a fast way to measure loudness in imported audio files or bounced mixes.

**To initiate offline loudness analysis:**

- Right-click the file in the Timeline, and choose Analyze Audio Level from the contextual menu. A dialog box displays the available options for measurement.

All of the measurements available in the real-time loudness meter are accessible in the drop-down menu inside the Analyze Audio Level panel. When the analyzer mode is chosen, the target measurements for that mode will display next to the reading in parenthesis. Once you have clicked the analyze button, the results will display in the panel next to the chosen mode’s target measurement values.

Select the audio file, choose the desired analyzer mode, in this case EBU R128, and click analyze.
Visualizing Loudness Monitoring

When you show the track of a Main bus in the Timeline, as long as the track is high enough (ahem, tall enough), you can show or hide a series of “Loudness History” curves to visualize the loudness analysis of the mix on that bus over the duration of the mix.

The available curves are:

- **Integrated**: A thick curve shows the averaged “integrated” loudness analysis of the current mix, which is a measurement that’s taken from the beginning to the end of playback. This graph is the primary gauge of whether or not measured loudness is acceptable. The color of each segment of this curve indicates whether that part of the mix is “to spec.” Blue indicates loudness levels that are below tolerance, yellow indicates loudness values that are within tolerance, and red indicates loudness values that are above tolerance. By evaluating the colors of the curve, you can easily spot which parts of your mix might need adjustment to meet the necessary specification.

- **Momentary**: A measurement of the loudness measured in the past 400ms, shown by a thin green-blue curve, which provides an analysis of transient level changes.

- **Short Term**: A measurement of the loudness of the past 3 seconds, shown by a thin blue line, which provides a more averaged analysis than the Momentary curve, yet still indicates the dynamics of the mix.

To show the loudness history for Main 1:

1. Open the Automation controls by clicking the automation button on the Fairlight toolbar.
2. Open the Index, and click the eye button for the Main you want to see in the Timeline. Loudness History appears as an option in the track header controls as long as the track is tall enough to show the controls. These controls will be hidden on short tracks.
3. Turn on the Loudness History toggle, and check the curves you want to see. The Integrated, Momentary, and Short Term loudness analyses can be individually displayed or hidden, to expose overlapping graphs in that track in which you can see your program’s loudness over time.

**NOTE**: At the time of this writing, loudness history is only supported for Main 1.
Viewer

A small viewer to the left of the Monitoring panel shows the frame of video at the position of the playhead. This is the same image that’s output to the external broadcast display of your workstation if you have one connected.

The Viewer lets you see the picture you’re mixing to.

Clicking the Expand Viewer button at the bottom right-hand corner lets you open the Viewer into a floating window, which you can then position anywhere you want.

To close the floating Viewer, click the Dock Viewer button at the upper right-hand corner of the floating viewer window.

Click the button at the upper right-hand corner to dock the Viewer again.

Cinema Viewer on Fairlight Page

Sometimes when you need to verify lip sync, sound effects sync, or simply review a new section of a mix you’ve been working on, it helps to watch the visuals of the program full screen as you listen to your mix. You can now set the Fairlight page Viewer to Cinema Mode by choosing Workspace > Viewer Mode > Cinema Mode (Command-F).
Chapter 179

Signal Flow Diagrams

The diagrams in this chapter describe the audio signal flow that takes place within the Fairlight audio processing used by DaVinci Resolve. They’re intended for people who want an in-depth understanding of how audio is processed.

Contents

Signal Flow Overview
Audio Processing Path
Signal Flow Overview

The following simplified flow diagram describes Fairlight audio processing overall.

Audio Processing Path

---

Chapter 179  Signal Flow Diagrams  3343
Chapter 180

Immersive Audio Workflows

DaVinci Resolve offers substantial support for object and channel-based surround or immersive audio formats. This chapter describes how to set up and mix with these formats when mixing in the Fairlight page.

Contents

About Immersive Audio Formats 3345
Expanded Dolby Atmos Capabilities 3345
Dolby Atmos Speaker Configurations 3346
Enabling Dolby Atmos 3346
The Components of a Dolby Atmos Mix 3346
Predetermined Dolby Atmos Master Rules 3347
Immersive Format Configuration 3348
New Surround Buses in Fairlight (Studio Only) 3348
Object-Based Format Support (Studio Only) 3348
Auro-3D Support (Studio Only) 3348
Dolby Atmos Configuration Controls 3349
MPEG-H Authoring 3349
Track Configuration 3350
Export 3350
Quality Control 3351
B-Chain Support for Audio Monitoring (Studio Only) 3352
Overview of Setting Up a B-Chain Configuration 3353
Space View Channel Monitoring 3356
About Immersive Audio Formats

Immersive audio formats use multiple channels of audio to position audio around an audience, to add a specially creative dimension to sound design. At their simplest, formats such as 5.1 and 7.1 surround allow the mixer to send varying amounts of any given track to the combination of speakers that makes audio sound centered in front, ambient from the rear, or weighted towards the left or right of an auditorium or living room. More sophisticated “object-based” formats such as Dolby Atmos define a virtual soundstage on which you can actually position tracks in 3D space, and the resulting positional audio is rendered by specialized encoder/decoders to however many speakers in whichever configuration a venue happens to have.

Expanded Dolby Atmos Capabilities

DaVinci Resolve 17 significantly improves Dolby Atmos mixing. The traditional surround sound experience outputs a specific set of monitoring channels that requires a specific number of monitor speakers placed in particular areas of a room, which can position sound approximately within a ring around the listener. Dolby Atmos improves upon this by being an object-based sound system operating within a 3D immersive space that can accommodate a wider variety of different speaker configurations using more speakers positioned around the listener. This increases dimensionality with more precise sound placement, adding height channels to produce sound that comes specifically from above.

A practical example of this difference can be heard when panning in a 7.1 mix; since you’re sending signals to specific points in a speaker array, those points are fixed. Although the physical size of rooms can be larger or smaller, the mix is always sent to those assigned point speakers, so the experience from room to room may be inconsistent. By comparison, Dolby Atmos gives re-recording mixers a way to mix to an idealized space instead of fixed speaker positions. This means a Dolby Atmos mix, when played in a Dolby Atmos room, takes into account the actual dimensions of the space, as well as the number of speakers that are used, to recalculate audio playback to suit that exact space and playback equipment, giving a more faithful recreation of the mix with much more specific sound placement, when necessary.

To give a clear example of the benefits of Dolby Atmos, think of a small theatre that has standard left, center, and right front-screen speakers. It then has four left surround and four right surround, four overhead left, and four overhead right. For this example, let’s say you have sent a sound to the surround left in Atmos, positioned at about one-half of the distance from the screen.

Now move the Atmos mix to a much larger room with twice as many monitor speakers. The new theatre has eight left surrounds, eight right surrounds, eight overhead left, and eight overhead right. Playing in this new configuration, Atmos automatically calculates the ratio of the room and the new speaker array. In this example, when that sound is reproduced at one-half of the distance from the screen, Dolby Atmos calculates the ratio of the sound in relation to the new playback setup, so the listener hears exactly what the re-recording mixer intends.

For this example, let’s say to have that audio playing back at one-half of the distance from the screen in the small room, the audio is played on the second surround speaker on the left. When this same audio is played in the larger room, Atmos determines that the fourth surround speaker is one-half the distance from the screen. The importance is not what speaker the sounds are assigned to but rather where in space the sound should be heard. Atmos calculates the ratio of the playback spaces and monitor speakers to faithfully reproduce a mix, rather than assign sounds to a fixed speaker position.
Dolby Atmos Speaker Configurations

It is important to understand that the term Dolby Atmos isn’t restricted to describing any particular speaker layout. Dolby Atmos is a complex metadata-driven system that interprets the audio from a configured Atmos mix, determines the playback system of the end user, and calculates the mix to fit each particular space and system. Assuming the possession of a Dolby Atmos compatible system, if a 9.1.6 Atmos mix is played by someone with only a two channel playback system, then it will intelligently down mix the 9.1.6 Atmos to stereo. If a user has a standard 5.1 monitor system, then the 9.1.6 Atmos soundtrack will down mix to five channel surround with a subwoofer.

The naming of the channel configurations in the Dolby Atmos format includes the height channels in the nomenclature. Channel configurations are presented as three digits separated by periods, such as 7.2.4, which is a typical speaker configuration. The first digit describes the number of main, or ear-height monitoring channels that surround the listener. The second digit describes the number of subwoofer channels. The third digit describes the number of height channels, which are speakers positioned on, or in the case of a soundbar pointed to, the ceiling.

An example of a 7.1.4 Atmos monitor speaker configuration:
- Seven surround channels
  - Left
  - Center
  - Right
  - Left Surround
  - Right Surround
  - Left Back Surround
  - Left Right Surround
- One Subwoofer
- Four height channels

Enabling Dolby Atmos

Atmos must be enabled by going into Project Settings > Fairlight tab > Immersive Audio and turning on Enable Dolby Atmos. When enabled, the Change Track Type contextual menu when right-clicking on a track will then include the additional Atmos track types.

The Components of a Dolby Atmos Mix

Mixes created in Atmos have several specifically identified components. These work together to create an immersive mix, but each element allows the Dolby Atmos system to fit the sound specifically to the space and speaker configuration during playback. These consist of:

- **The Bed track:** Contains the bulk of mixed audio, including dialog, ambient sound effects, and music. These sorts of sounds will contain panning information, but the panning will be general. Wind, traffic in the distance, room tones, and sync dialog would all most likely fall within the bounds of a standard bed track of 7.1.2 or 9.1.6. These are tracks with fixed monitor locations.

- **Object tracks:** Pinpoint the placement of sounds moving specifically across the immersive space. Users can use these specific tracks to create panning anywhere in the room. Sounds can fly through space, around a room from height channels, to side and back back channels, mimicking the motion of objects on the screen. Object tracks use the Atmos metadata to do the calculations discussed in the last example. ADM files are Atmos exports used with the IMF file type as master deliverables, which are in the broadcast wave file format.
It’s up to users to define which tracks are Bed tracks, and which are Object tracks; these track designations, are descriptions of what the tracks you create are going to be used for. Ultimately, it’s up to the mixer which audio is organized on Bed tracks, and which is organized on Object tracks. Theoretically, users can create a mix consisting entirely of Object tracks if desired, but typically the mix would be split into beds consisting of generally panned sounds, and Object tracks for sounds requiring specific room placement.

Object tracks and height channels open up possibilities that were never possible prior to Atmos. Imagine a scene where a man is hiding from Police while a helicopter circles overhead, or a scene where kids are in a basement and are startled to hear loud footsteps above them. With Atmos, the audience can now experience these immersive sounds along with the characters.

These are real-world examples, but sound in animation, science fiction, and fantasy can explore space in ways that are only limited by the creator’s imagination. Flying fairies or creatures can move about the space front to back, high and low. Perhaps there’s a scene with a ship moving full speed ahead underwater, breaking up and out into the sky, flying and dodging weapons coming from all sides. Object tracks are ideal to pinpoint sound effects requiring spatial specificity, but more importantly, Atmos assures the re-recording mixer that the final choices made in the mix will be faithfully recreated from theatre to theatre, and from room to room.

Predetermined Dolby Atmos Master Rules

The first ten tracks in every Dolby Atmos Master are assigned as a bed by default. From there the default bed is a 7.1.2 bed, however, it can be designated to a 2.0 up to the 7.1.2 bed. There is no option to add objects to these first ten tracks. Starting at track eleven, the tracks that follow can then be made into various beds or objects as needed.

A simple way to think of this is that buses routed to the Atmos Master are treated as beds, carrying predefined multiple sources. An Atmos bed is a fixed surround format that can contain height channels. Objects, are generally mono but can send any format track that DaVinci Resolve supports and follow the metadata as a single object element. Objects routed to the Atmos Master are treated as tracks, carrying dynamic audio content and positional metadata. LFE will need to be sent to a bed, since objects are positional metadata. If the object is 5.1 for example, the LFE channel will need to be routed to a Bed bus in order to be rendered in the Atmos master.

The Dolby Renderer will render the file if it is dragged from the Media Pool into a track in the Timeline. In this case it will render the media with the embedded metadata to the master’s output format. This is a simple way to monitor pre-mastered content and to perform simple actions, such as trimming or syncing for new packaging and deliverables.

When importing a Dolby Master file from the Fairlight menu, Fairlight > Immersive Audio > Import Master File, the resulting import will extract all of the audio and metadata for further content creation. This type of importing into Fairlight maps all of the metadata, tracks, beds, and objects from the master file into the Timeline, allowing you to adjust, process, and manipulate further, to rewrite panning, punch-in and add new media, and create a new Atmos Master.

Dolby Atmos files are a package of items. Simply linking files will not create an Atmos Master file. It is not possible, for instance, to take a rendered set of twelve tracks, link them, and then configure their outputs to a 7.1.4 Atmos bed. Note that 7.1.4 is not a Atmos bed type. Although this is the way typical PCM audio is linked and routed, it is not the case for Atmos content, which is far more than just a collection of tracks.

The renderer takes the 128 channels consisting of the beds and objects and renders it. Those channels are either internal sources or contained within the master file. A simple linked file will not play back through the Renderer. It must be played back as all linked files in Fairlight do, through the native monitor. The Dolby Atmos Renderer plays, renders, and extracts Atmos Master files. Fairlight allows for .atmos, ADM, and IMF file types to be imported and played through the Renderer.
Immersive Format Configuration

You can enable these audio surround formats in the Fairlight panel of the Project Settings. Once enabled, all supported channel configurations of each format become available for timeline track mappings, clip attributes channel mappings, Fairlight bus mappings, and output settings.

New Surround Buses in Fairlight (Studio Only)

The new Flexbus structure in Fairlight enables user-definable buses. Atmos mixes call for several bus formats that are now available in DaVinci Resolve 17.

- 9.1.4
- 22.2

Object-Based Format Support (Studio Only)

- Dolby Atmos with support for 7.1.2 and 7.1.4
- MPEG-H with support for 5.1.4, 7.1.4, and 7.2.3
- SMPTE ST.2098 with support for 9.1 OH, 9.1 HT, 11.1 HT, 13.1 HT, and 15.1 HT

Auro-3D Support (Studio Only)

- Auro-3D with support for 9.1, 10.1, 11.1 (7+4), 13.1
Dolby Atmos Configuration Controls

The Video and Audio I/O panel of the Resolve System Preferences lets you enable and configure the use of a Dolby RMU for doing Dolby Atmos mixing. You can enter the IP address of the RMU, and choose the base audio output.

MPEG-H Authoring

DaVinci Resolve enables MPEG-H authoring. This includes Native MPEG-H track and bus formats and monitoring, including the ability to define basic track-level meta-data for export into an MPEG-H scene, and export of a MPEG-H Master file. Once enabled, the formats become available for selection as a bus, track, or monitoring format, in the Bus Format window.

These formats also become available for multi-channel track assignment.
Tracks are mixed natively in a similar manner to most immersive content, with the creation of a bed mix consisting of a set of immersive object tracks that use dynamic panning. These are combined onto the main bus to form the immersive mix.

**Track Configuration**

In addition to this process, once the format is enabled, a set of MPEG-H meta-data columns become enabled in the DaVinci Resolve Track index, including Track Type, Kind, Language, SW Group, and Preset. For more information about these columns and how to configure them, see Chapter 167, "Using the Fairlight Page."

**Export**

Once everything is configured, and your project is mixed, you export a master file. In order to do this, you must select a range In and Out point on the Timeline to define an export range. Additionally, you must define whichever busses are designated for rendering by defining their Kind, and you can select tracks you want to export additionally.
Selecting tracks and busses to export

**NOTE:** An MPEG-H master file can only contain a maximum of fifteen channels total. If the selected track and bus stems exceeds this, then the export will fail, issuing a warning. The same will occur if a range is not selected.

**To export an MPEG-H mix:**

2. Choose a save location and name, and click Save.

At this point, all defined buses are rendered. Then, track loudness is measured for compliance. Lastly, the source audio is exported and the metadata embedded into the deliverable MPEG-H wav file.

There are several error conditions, which are deleted during the export process, that will all cause the export to fail. For example, all tracks must contain audio. Audio within switch groups must be within a specific loudness tolerance of one another. If any of these conditions occur, a dialog will appear.

**Quality Control**

You can do a quality control check of the final audio export using a Fraunhofer MHAPI tool which can open up the exported content. This includes compliancy tests, and visualization of the contained metadata. It can also render and monitor the content, but this aspect of the tool is basic, and only works with external audio that’s linked to the metadata. In other words, you must manually link the components back to the source audio files.
Quality control using the Fraunhofer MHAPI tool

B-Chain Support for Audio Monitoring
(Studio Only)

Choosing Fairlight > Immersive > B-Chain Control opens the B-Chain Control window. Using traditional cinema audio postproduction terminology, the “A-Chain” is all of the busing and signal processing that happens within the mix (in our case using the Fairlight page) and the “B-Chain” is the signal processing, amplification and speaker system that takes the sound from your workstation’s output and gets it “into your ears.” This typically includes all necessary signal decoding or pre-processing hardware, amplification systems, and speaker setups for most professional and commercial listening environments, especially for immersive audio or surround sound formats. These options are complex and have many variables in terms of speaker configuration, selection, and placement, output channel timing, attenuation, and phase, and a host of other considerations.

In DaVinci Resolve, these B-Chain controls affect how the channels of audio being output by the Main you’re mixing is mapped to the actual audio signals being output from your workstation into the amplification and speaker system of the current viewing environment. The extensive level of control the B-Chain presets offer is most useful in situations such as surround-sound configured grading and mixing theaters, to define how the immersive audio standard you’re mixing is mapped to the speaker setup of your particular application, and to fine-tune the channels being output to each speaker specifically for your environment. In simpler monitoring situations, the B-Chain controls can be useful for configuring the standard you’re mixing with to play out of a non-standard speaker setup in your room.

Ultimately, the B-Chain controls are designed and intended for users who need to create custom, fine-tuned settings for their specific monitoring situation. For this reason, pretty much every real-world use of these B-Chain controls will require custom configuration for your unique environment.
Overview of Setting Up a B-Chain Configuration

Setting up a B-Chain configuration takes some doing, but once set up, you have a preset that’s easy to reopen at any time. In the following example, a B-Chain preset will be configured to convert a 5.1 surround output to a 3-channel left-center-right room speaker setup.

To set up a B-Chain:

1. Choose Fairlight > Immersive > B-Chain Control to open the B-Chain Control dialog. This exposes the monitoring controls but not the configuration controls.

2. Click the Option menu in this window and choose Setup B-Chain Presets. The B-Chain Setup window appears.

3. Click the New button to create a new B-Chain preset, then enter a name in the dialog and click OK. In this example we’ll use the name “5.1 to LCR.” The Name you enter here is the name of the saved setting data.

   Additional buttons let you Delete, Rename, or Duplicate presets that you’ve already created once you choose them from the Setting pop-up.

4. Enter a label in the Name field (this is the name that appears in the preset menu). The name you enter here is the name that appears in whatever pop-up menus you select these options from.

5. Choose Input Mode > Fixed Format, and Input > 5.1 from the pop-up menus. These define the signal coming out of your mix. (Input Mode > Monitor Feed sets the B-Chain to listen to the selected monitor source, while Input Mode > Custom Format lets you choose an arbitrary number of channels.)

6. Choose an Output Mode > Fixed Format, and Output > LCR from the next set of pop-up menus. These define the speaker setup you’ll be playing the mix out of. In this example, we’ve chosen LCR, which stands for Left, Center, Right.

   At this point, you can see that once you’ve defined the Input and Output channels, the “Inputs/Outputs” table of cells becomes populated:

   – At the left of this table, each channel of your selected Input occupies a vertical column. In this example, the Input columns are labeled L, R, C, LFE, Ls, Rs, corresponding to the 5.1 channels you’ve selected to be output. It’s possible to specify setups with many more channels, in which case the left half of the table becomes scrollable.

   – At the right of this table, each channel of your selected Output occupies a horizontal row that intersects the Input columns. In this example, the rows are labeled Left, Center, Right.

   In this way, every Input column intersects with each Output row, making it possible for you to assign how much of each Input is fed to each Output by entering values into each intersecting cell.
To assign Input channels to Output channels, double-click the field where the desired Input intersects the desired Output, and type a value to set how much level from the Input to assign to the Output. Typing 0 assigns Input to Output at “unity” gain (0dB). Numbers you type here specify tenths of a dB. Typing -3 assigns half of the level from Input to Output. Typing -100 mutes that Input to that Output completely. Blank cells with no value make no assignment. In this example, we’re typing:

a. 0 into cell L-1 to assign all of the Left source to the Left output
b. 0 into R-3 to assign all of the Right source to the Right output
c. 0 into C-2 to assign all of the Center source to the Center output
d. -6 into Ls-1 to assign a fraction of Left surround to the Left output
e. -6 into Rs-3 to assign a fraction of Right surround to the Right output
f. -8 into LFE-1 to assign a smaller fraction of LFE to the Left output (LFE is not directional)
g. -8 into LFE-3 to assign a smaller fraction of LFE to the Right output as well (LFE is not directional)

At this point, we’ve fully defined how much of which Input channels go to which Output channels. In the process, you can see that this table interface makes it possible to assign the full levels of Input channels to Output channels, to assign partial levels of Input channels to Output channels, and to assign fractions of Input channels to multiple Output channels.

The Inputs/Outputs table of the B-Chain preset window fully populated to assign inputs to outputs

At this point, you should notice there are additional columns to the right of the Output channels that provide various options that let you fine-tune each channel’s output in order to optimize the acoustics and layout of your room:

– Trim each channel (in tenths of a dB)
– Add a Delay (in milliseconds)
– Add specific EQ (None, LFE Only, Surr Mode)
– Mute or Solo groups.

The last thing you need to do is to right-click each Output channel row’s right-most Output column, and choose the hardware output of your audio or video+audio interface that you want that channel to go to. See one of the following I/O Setup procedure for how to rename these options to make this easier.

Once you’ve finished setting up your B-Chain preset, click OK, and that preset will be saved and available for use.
To choose a B-Chain preset to use and enable B-Chain:
1. Choose Fairlight > Immersive > B-Chain Control to open the B-Chain Control dialog.
2. Turn on the toggle at the upper left-hand corner of the window to enable B-Chain, and choose a preset from the pop-up menu.
3. Choose the Input you want to assign that B-Chain preset to.
4. A set of Solo and Mute buttons lets you selectively choose sets of channels you want to listen to in isolation, or mute from the whole, in order to better evaluate selected portions of your mix.
5. A Fixed Level button lets you fix the output level in the DaVinci Resolve UI to a single value. With this enabled, you cannot drag the level slider to change the monitoring volume.
6. When you’re finished using B-Chain for monitoring, turn off the toggle at the upper left-hand corner.

**NOTE:** While the B-Chain is enabled, the Speaker Setup controls in the Video and Audio I/O panel of the Resolve System Preferences is disabled.

To name the various outputs of your system’s channels for easy assignment:
1. Choose Fairlight > Immersive > B-Chain Control to open the B-Chain Control dialog.
2. Click the Option menu in this window and choose Setup I/O Names. The I/O setup window appears, showing every single audio input and output on every audio interface that’s connected to and recognized by your system.

The I/O Setup window lets you rename the Inputs and Outputs associated with your workstation setup, to make it easier to configure Fairlight when you’re managing hundreds of channels. The names you choose here are shown everywhere in DaVinci Resolve where channels are selectable and/or exposed.

3. To rename a channel, double-click that channel’s field in the Name column, type a new name, and press Return.
4. To protect a channel, click the checkbox in the Protect column. Protected channels are prevented from being patched to. This is intended for potentially high-volume speaker outputs, to which it would be hazardous to accidentally connect the wrong input. Protected channels can be seen everywhere patches can be made, but they’re grayed out. Protected channels can only be used in the Speaker Setup controls in the Video and Audio I/O panel of the Resolve System Preferences, and in the B-Chain Setup window.
5 When you’re finished, close the window. The names and protected status of channels are a system-wide setup.

The I/O Setup window where you can rename your system’s audio outputs and protect channels going to amplified speakers

Space View Channel Monitoring

Once you’ve configured your DaVinci Resolve workstation to mix audio via an Immersive format, you can use the Space View to facilitate surround sound mixing. Choose Fairlight > Immersive > Space View Scope to open the Space View window, which is a virtual representation of your control room with all defined source channels positioned in space according to the speaker that channel is intended to play out of. This view makes it easy to see which audio channels on which timeline tracks are playing out each speaker.

The Space View window gives you a spatial representation of what levels are playing where; this example show the various stems of a 5.1 mix.

Each channel shows a label and a meter that lets you see, at any given part of the mix, what audio levels are playing where, spatially. However, you only see channels that are unmuted and with a fader level of more than -70dB. A checkbox lets you choose whether to see labels for all track channels in your mix, or to only show labels for track channels with active levels that are currently playing. The Space View is also aware of the state of all Solo controls, allowing you to quickly focus on just what you hear.
Chapter 181

Using the Fairlight Desktop Console

The Fairlight Desktop console is the newest member of the Fairlight console family and offers professional mixing controls for editors and audio professionals alike. This compact desktop console has enhanced mixing controls for both the Edit and Fairlight pages in DaVinci Resolve.

This chapter provides details and functional descriptions of each section of the Desktop Console and should be read in conjunction with the Fairlight chapters in the DaVinci Resolve Reference Manual to get the best from your console.

NOTE: To set up a Fairlight Desktop Console and connect it to your DaVinci Resolve system, open the Control Panels settings in System Preferences, and change the Audio Console Select this console for Fairlight drop-down menu to Fairlight Desktop Console.

Additionally, firmware updates for the Desktop Console are installed via the DaVinci Control Panels Setup utility. You’ll find details for downloading and installing firmware updates at the end of this chapter.

Contents

About the Fairlight Desktop Console 3358
Connecting to a Monitor via HDMI 3359
Desktop Console Functional Overview 3361
Types of Controls 3361
Desktop Console Modes 3362
Undo, Modifier and Arrow Keys 3363
Track Select Buttons 3363
About the Fairlight Desktop Console

Fairlight Desktop Consoles offer traditional and enhanced mixing controls for both the Edit page and Fairlight page in DaVinci Resolve. All that you need to connect a Fairlight Desktop Console to your DaVinci Resolve computer is a standard USB-3 or Ethernet cable. Once connected to your workstation, you can use the transport controls and search dial on the Desktop Console for timeline navigation, recording, playback, and more.

Fairlight Desktop Console Sections in Clockwise Order

On the upper-left of the Desktop Console there is a set of 10 control buttons that are used to map the 12 adjacent encoder knobs and select buttons to focus mode mixing parameters. Moving to the upper-right of the Desktop Console, you’ll find the Automation section with six buttons used to control the automation system. Below the Automation section are the channel and monitoring controls. The channel controls include three buttons that work in conjunction with the channel select buttons above the faders and two bank buttons for banking faders in groups of 12 in the relative direction. To the right
of the Channel section are the monitoring controls complete with an encoder knob and four buttons to target the Control Room monitoring. Additional TALK and CANS buttons add studio controls and can be pressed and held for talkback and re-targeting the monitoring controls for studio monitoring. The lower-right of the Desktop Console includes an electronic search dial for full shuttle and scroll transport control, along with a set of transport keys. A handy Zoom Icon button below the dial lets you use the dial for quick timeline zoom functions including: horizontal, vertical, and waveform zoom.

The center of the Desktop Console includes 12 fader channel strips, each with a belt-driven touch-sensitive fader, Mute, Solo, and Select (SEL) buttons, as well as an encoder knob for panning in default mode and controlling additional parameters in Focus modes. At the top of each channel strip you’ll find an LCD screen that displays information for that channel in default mode or alternative parameter information in Focus modes.

Arrow and Modifier keys are located in the lower-left of the Desktop Console and can be used in conjunction with the Transport, Channel, and Automation buttons for expanded functionality. Directly above the Arrow keys is the User section, containing six sequentially numbered buttons that can be used in combination with other keys to change the current operation depending on the mode and task at hand.

Connecting to a Monitor via HDMI

For additional visual feedback, you can add an HDMI display to the Fairlight Desktop Console. There’s no configuration needed, simply plug in an HDMI monitor and start working! This allows you to see an extensive graphical display of everything happening on the console. The screen automatically switches between Strip, Channel, and Master layouts depending on the current control mode. Along the top of the HDMI screen you’ll always see a fixed display that includes: timecode, monitoring controls, automation toolset, and the Bus, Control Room, and Loudness meters. While at the bottom of the screen you’ll see 12 sets of Channel Extension Buttons for quickly identifying channel status while you work.
Optional HDMI monitor displaying Strip mode layout with an identical set of parameters inline with each of the 12 channel strips, including from the top down: Track color, Name, Level, Status, EQ, Dynamics, Panning controls, and Channel Extension buttons.

Optional HDMI monitor displaying the Channel Control mode layout, which includes 192 different parameters for the active channel. Parameter controls currently mapped to the LCD displays, knobs, and SEL buttons are highlighted with blue text.
Desktop Console Functional Overview

This section offers a rundown of the various types of controls, operational modes, transport, and modifier keys, as well as pointing out the multi-purpose track selection buttons, encoder knobs, and LCD display screens within the console.

Types of Controls

The Fairlight Desktop Console comes loaded with an assortment of 111 physical controls that you can use to record, monitor, mix, and sweeten your soundtracks. Some buttons serve a single purpose, while others serve multiple functions, therefore it’s a good idea to understand the different types of controls before moving on to the specific button, knob, and fader details.
– **Search Dial**: To quickly navigate, scroll, and zoom, this fully integrated, highly-responsive electronic dial offers smooth free rotation control.

– **Knobs**: When you want to make fast changes to specific parameters, these versatile knobs give you precision rotary control, as well as touch-sensitive input for enabling automation or resetting levels. Holding the Shift modifier key changes the gearing for finer precision control, while holding the Control modifier key while touching one of these knobs will reset the knob’s current parameter to its default value.

– **Fixed Buttons**: Fixed buttons serve a specific function and produce the same results every time they are used, regardless of the operational mode or current workflow.

– **Soft Menu Toggle Buttons**: The twelve Select (SEL) buttons near the top of the fader channel strips are multi-functional toggle switches that change based on the console mode and active control button.

– **Faders**: The 12 touch-sensitive electronic faders give you precision volume control for your tracks and buses, and correspond with faders on the onscreen Mixer in DaVinci Resolve.

### Desktop Console Modes

The upper section of the 12 Channel Strips, including the Select (SEL) buttons, knobs, and LCD screens, can operate individually per channel in Strip mode or combined for a comprehensive set of parameter controls in Focus mode. In both cases, the different tasks are engaged via the button selection in the Control section to the left of the knobs and LCD display area.

#### Strip Mode

This is the default console mode, when none of the control buttons are active.

**Strip mode functionality includes:**

– 12 identical sets of fader channel controls, one for each fader channel strip.

– Each LCD display, knob, and SEL button is associated with the Fader, Mute and Solo button that is in line with that channel strip.

– The Select buttons are used for track selection and illuminate accordingly when they are switched on.
Focus Mode

In contrast, Focus mode, focuses all of the knobs, Select buttons, and LCD displays on a single mixing task or parameter control set determined by the active Control button. These focused control sets mirror signal processing available in the Fairlight page Mixer, such as Pan and EQ, as well as dynamics like the Compressor and Limiter.

Focus mode functionality includes:

- The LCD display at the top of each channel strip provides visual feedback for the active parameter set assigned to the adjacent knob and SEL button.
- SEL buttons become toggle switches for the active parameter control set.
- Knobs are mapped as precision encoders for the active parameter control set.
- Focus mode controls collectively mirror the corresponding parameter controls in the Fairlight page UI.
- Focus mode parameter sets control the signal processing for the active track or bus determined by the selection buttons prior to entering Focus mode. The active track is the most recently selected track.
- When the Master (MSTR) control button is active, the focus mode LCD, SEL buttons, and knobs are mapped to each bus as Mute and Level controls, respectively.
- When the Channel (CHNL) control button is active, the focus mode LCD, SEL buttons, and knobs are mapped to the most commonly used signal processing parameters for the active track.

Undo, Modifier and Arrow Keys

While working with the Fairlight Desktop Console, you will always have access to the Undo, Modifier, and Arrow keys, conveniently located on the lower left side of the console. The Arrow keys function like the Arrow keys on a standard keyboard and are used in conjunction with the transport buttons to move the playhead (CTI), selected clip, range, or selected tracks incrementally up, down, right, or left. The Undo key offers the failsafe option to go back a step at any time, just as you would expect during normal keyboard and mouse workflows. Additionally, the SHIFT, ALT and CTL modifier keys are used with other console controls to expand functionality and speed up your workflow. For example, while you hold the Control key, the Rewind and Fast Forward transport buttons act as Project Start and Project End buttons to quickly jump to the beginning or end of the Timeline. The Shift modifier key can be used with the knobs for fine incremental parameter control, while the ALT modifier key used with Undo results in Redo functionality to go forward a step.

NOTE: If your Desktop Console is connected to a Fairlight Audio Editor, the Control (CTL), Shift, and ALT keys on the Desktop Console work in tandem with the modifier keys on the Fairlight Audio Editor.

Track Select Buttons

The Fairlight Desktop Console includes a dedicated row of multi-function Select (SEL) buttons at the top of the channel strips for selecting either tracks or master buses. From left to right, the 12 Select buttons follow the order of the tracks in the Mixer, and in the Timeline from top to bottom. Use the bank buttons to move to the next or previous set of 12 tracks.
Track Select Buttons

12 Track Select (SEL) buttons

- **In Focus mode**, track Select buttons become toggle switches for switched parameters assigned to the focused channel strip. Focus mode parameter sets are determined by the control buttons in the upper left of the Desktop Console.

- **In Strip mode**, the Select buttons can be used to select the track or bus assigned to that specific channel strip. Pressing a Select button is the same as clicking a track header or channel strip in the Fairlight page Mixer with your mouse. Select buttons illuminate when latched and the top of the corresponding LCD brightens so you can always see at a glance which tracks are selected in Strip and Focus modes. Likewise, if you are using an optional HDMI monitor with your Desktop Console, you'll see illuminated Select buttons for each selected track in the Channel Extension buttons along the bottom of the screen.

- **The Active track** reflects whichever track is actively being controlled or touched with any of the channel strip controls. You can select and control multiple tracks at once; however, only the most recently touched track is considered the active track. For easy identification, the active track’s name turns red in both the LCD display and the Fairlight page Timeline. It is important to recognize the active track because that will be the track that receives focused parameter controls in Focus mode.

**Track Select Button Press Options**

The default Strip mode Select buttons include some unique selection nuances to improve your efficiency without the need for a mouse.

- Press once to select or deselect a track.

- Select as many tracks as needed, one track at a time, by simply pressing the corresponding SEL button.

- Double-press any SEL button to deselect all other tracks and exclusively select the current track.

- To select a range of tracks, hold a SEL button, then double-press another SEL button to select both tracks as well as all contiguous tracks between them. In this case, the button that was double-pressed will become the active track.

**TIP:** To select all tracks or an extensive range of tracks, open the Tracks Index panel in the Fairlight page. Select a track in the Index, then hold Shift while turning the dial to extend selection. Additionally, you can select a track in the Tracks Index and choose Edit > Select All, or press Cmd-A on your keyboard to select all tracks.
Now that you are familiar with the general layout, types of controls, modes, and other options in the Fairlight Desktop Console, you are ready to take a more detailed look at the different areas of operation and how everything works together. One primary concept to keep in mind is that the Fairlight Desktop Console is designed specifically to control the DaVinci Resolve Fairlight page. Therefore, the better you understand the Fairlight page, the more proficient you’ll be with your console.
Please refer to previous Fairlight chapters for detailed information on the software interface, tools, functions, and audio workflows. Meanwhile, this section will give an overview of the entire Fairlight Desktop Console and focus in-depth on unique features and functions that go beyond the standard keyboard and mouse options in the Fairlight page.

**Control Buttons**

The twelve control buttons in the upper-left corner of the Desktop Console offer fast access to all of the mixing parameters available in the Fairlight Mixer, without the need to grab your mouse. Each control button maps a different set of mixing parameters to the upper section of the channel strips. These parameter control sets are identical to the parameter controls in the corresponding UI windows accessible in the Fairlight Mixer. Additionally, if you are using an HDMI monitor with your Desktop Console, the active control set parameters on the monitor screen are highlighted in blue text.

The control sets include the LCD screens, knobs, and SEL buttons and work collectively for Focus mode operations. The control area defaults to the standard operational strip mode whenever there are no control buttons active.

**NOTE:** In each of the following control set examples, track *A3 DIA - Kate* is the active track. You can easily identify the active track because the track-based Focus mode control sets always display the active track’s name, number, and color in the first channel strip’s LCD.
Control Buttons from left to right, starting with the top row, include:

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSTR</td>
<td>The Master control button dedicates the adjacent LCDs, knobs, and SEL buttons to the Master buses. The default Master control set gives you direct channel control for up to 11 master buses. The knob controls the corresponding Master bus level, while the SEL button allows the bus to be muted.</td>
</tr>
</tbody>
</table>

Master control set mapping shows MAIN 1, MAIN 2, SUB 1, SUB 2, AUX 1, and AUX 2

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHNL</td>
<td>The Channel control set assigns up to 11 of the most commonly used channel controls to the knobs and also to the SEL buttons, if populated or active, primarily used as In/Out or On/Off switches. Knob controls update in realtime as they are adjusted. SEL switches illuminate when enabled and the label on the corresponding user interface switch in the LCD turns red. The Channel controls from left to right are: Active Track Dia - Kate A3, PATH Trim, HIGH PASS FILTER Frequency, Low EQ Gain, LOW MID Gain, HIGH MID Gain, HIGH Gain, LOW PASS FILT Frequency, COMPRESSOR Threshold, LIMITER Threshold, PAN Left/Right and Front/Back. These controls are also available in the associated Focus mode control sets.</td>
</tr>
</tbody>
</table>

Page 1 of the Channel control set mapping

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAN</td>
<td>The Pan control set maps all of the pan parameters available in the Pan window to the control area knobs with graphical feedback in the LCD. Pan controls are applied to the selected track. Pan controls assigned to each knob from left to right are: PAN, Left/Right, Front/Back, Rotate, Spread, Diverge, and Boom. Pan, Divergence, and Boom have On/Off switches assigned to the adjacent SEL switches.</td>
</tr>
</tbody>
</table>
Pan control set mapping includes all parameters in the Fairlight Pan window.

Pan window available in the Fairlight page Mixer

Pan control set visual feedback in optional HDMI monitor
PLUG: The Plug-in control sets differ from plug-in to plug-in. However, for each plug-in slot there are up to two pages (12+12) of user-mappable parameters on the encoder knobs as well as On/Off on SEL1, plus up to 11 user-mappable switch functions. In this example, the Fairlight FX Echo plug-in automatically maps parameters to the first 9 knobs and first two switches: ECHO On/Off, FILTER LowCut and STEREO Switch, FEEDBACK High Ratio, LEFT CHANNEL Delay Time, RIGHT CHANNEL Delay Time, Feedback Delay, OUTPUT Dry/Wet, and Level.

Hold Plug and press User 1 to User 6 to choose a different plug-in slot for focus. This also opens the corresponding Plug-in window in the Fairlight page interface.

EQ: The EQ control set includes two pages of controls. Press the EQ button to load the Page 1 control set, mapped left to right across the encoders and SEL switches. Master Gain trim appears at knob position 2, and knobs 3-12 control Bands 2-5, alternating gain and frequency. The SEL switch at position 1 switches the EQ on/off, and the remaining SEL switches toggle either the Frequency band ON/OFF or the shape per band.
Hold CTL and press EQ to switch to Page 2.

This EQ control set focuses on the High Pass and Low Pass filters on Bands 1 and 6, and the corresponding SEL switches toggle the filters ON/OFF or shape. Press EQ again to return to Page 1 and repeat as needed to toggle between Page 1 and Page 2. The EQ control set mirrors all of the parameter controls available in the Fairlight EQ window.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQ</td>
<td>Hold CTL and press EQ to switch to Page 2. This EQ control set focuses on the High Pass and Low Pass filters on Bands 1 and 6, and the corresponding SEL switches toggle the filters ON/OFF or shape. Press EQ again to return to Page 1 and repeat as needed to toggle between Page 1 and Page 2. The EQ control set mirrors all of the parameter controls available in the Fairlight EQ window.</td>
</tr>
</tbody>
</table>

EQ control set Page 1 with controls for Bands 2-5

EQ control set Page 2 with controls for the filters on Bands 1 and 6

Fairlight EQ controls available via the Fairlight Mixer
The EXP control set includes all of the Expander and Gate parameter controls available in the Fairlight Dynamics window. The first channel strip shows which track is in focus, or active, while the SEL button toggles between Expander/Gate controls. The subsequent six channel strips include knob control for the Expander/Gate parameter in the order they appear on the Dynamics window. From left to right in Channel Strips 2-7 the controls are: Threshold, Range, Ratio, Attack, Hold, and Release.
Key Description

**COMP**: The Compressor control set includes all of the Compressor parameters as available in the Dynamics window. As with all of the other control sets, the Channel 1 position is where you’ll find the On/Off switch assigned to the SEL button. These subsequent controls from left to right include: Threshold, Ratio, Attack, Hold, and Release on the 2-5 knobs, and a Send/Listen SEL toggle for SideChain compression in the channel 6 position.

**LIM**: Like the other dynamics control sets, the Limiter control set includes all Limiter parameter controls assigned to the encoder knobs in the order they appear in the Dynamics window. The Limiter controls include: On/Off, Threshold, Attack, Hold, and Release.
Fairlight Limiter controls available via the Fairlight Mixer.

Fairlight Dynamics Window, which includes Expander, Gate, Compressor, and Limiter.

Compressor control set visual feedback in optional HDMI monitor. All Focus mode dynamics parameters grouped together in one section of the HDMI data screen. The active dynamics controls are highlighted in blue.
INP: This is the Input button and mirrors the Path Settings controls available on the Input section of the Fairlight Mixer. These controls appear in the same order as the do in the Fairlight page: SOURCE, PATH Mic/Inst, Rec Level, Trim, and Direct Output. The INP control set maps Mic Gain to the Channel 3 knob, or hold ALT to use the same Knob for Rec Level adjustments.
**Key Description**

SEND: This control set uses the SEL buttons to toggle Bus Send 1 On/Off for each of the 12 channels. These send controls mirror the Bus Send controls available in the Fairlight Mixer. When active, the knob controls the Bus Send 1 Level, or press and hold ALT to control the Bus Send L/R Pan.

---

**Fader Channel Strips**

The most prominent real estate on the Fairlight Desktop Console is dedicated to the fader channel strips. The upper section of these channel strips operate independently in Strip mode, or collectively for Focus mode tasks. The default operational mode of the console provides 12 fader channel strips, each with a Fader, Mute, Solo and Select (SEL) button, a rotary control knob for pan adjustments and a LCD Screen that displays channel information. Any changes applied to the channel strip controls are mirrored in the DaVinci Resolve Timeline and Mixer accordingly.

The desktop console remains in default mode for standard mixing operations unless one of the buttons in the control section is selected. For example, you may be using the faders and pan knobs on-the-fly to adjust track levels and panning during playback. Without stopping, you'd like to adjust the EQ for the active track. No problem, just press the EQ control button and the entire upper section of the channel strips, including the SEL buttons, knobs, and LCD screens, change function to the EQ focused mode. In EQ focused mode, the collective LCD screens, SEL switches, and knobs control specific EQ parameters that mirror the Fairlight Mixer’s EQ window controls.

When you finish adjusting the EQ, simply unlatch the EQ control button, and the console returns to the default mixing functionality. You can switch between control modes as often as you like during playback, recording, or other mixing tasks.

This section describes the default functionality of the fader channel strips.
Touch-Sensitive Faders
The bottom-half of the Fader Channel Strip area comprises 12 identical touch-sensitive motorized faders that offer precision gain controls for 12 signal paths. These faders correspond with faders on the Fairlight page Mixer. Touching a fader results in realtime graphical and numeric feedback of the current level on the adjacent LCD screen. Additionally, each 100mm fader has a DC belt-driven coreless motor and offers precision touch-control fader automation.

Faders can be reset to unity (0dB) by simply pressing the Control (CTL) button while touching a fader. Hold Control and swipe your hand along each of the twelve faders to reset them all in a single maneuver.

Channel Strip Control Buttons
Each channel strip also contains illuminated Mute, Solo, and Select status buttons for the individual channels. These toggle buttons can be pressed individually or swiped on or off. Highly-visual LED lights make it easy to spot which buttons are switched on or off at a glance, which is especially important in the middle of a mixing session. These channel strip buttons and their toggled states are mirrored in the DaVinci Resolve Edit and Fairlight page Mixers and Timeline track headers, as well as in the strip mode layout in the optional HDMI monitor.

Channel Strip Control Buttons include:

<table>
<thead>
<tr>
<th>Key</th>
<th>Hold</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SEL</td>
<td></td>
<td>SEL: In default mode, this button can be used to select a track, VCA master, or bus master assigned to that channel strip. Press SEL once to select or de-select a track. You can select as many tracks as you need for a given task. Channel buttons, located to the right of the Channel Strip control buttons, can be used as modifiers to change the SEL switch functions. Latch the AUTO channel modifier button to change the SEL switch function to Automation Write. Latch the REC channel modifier button to change the SEL switch function to Arm for recording. In Focus mode, latch the ENAB channel modifier button to enable the SEL switches to be used as Track Select buttons.</td>
</tr>
<tr>
<td>Key</td>
<td>Hold</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>--------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Solo Button" /></td>
<td></td>
<td><strong>SOLO</strong>: Use this button to hear only this channel during playback. Multiple tracks can be soloed simultaneously to isolate selective tracks for playback while all non-soloed tracks will be muted. Solo buttons work for the corresponding channel in both Strip and Focus modes.</td>
</tr>
<tr>
<td><img src="image" alt="Solo Button" /></td>
<td><strong>CTL</strong></td>
<td>Hold Control and press any Solo button to clear all soloed buttons. Hold Control and press any Solo button again to restore soloed tracks.</td>
</tr>
<tr>
<td><img src="image" alt="Solo Button" /></td>
<td><strong>ALT</strong></td>
<td>Hold ALT and press Solo to toggle on or off Solo Safe status. Tracks set to Solo Safe will always play, even if Solo is enabled for other tracks, and are easily identified by the blue-highlighted Solo status icon in the Fairlight page Mixer and Timeline track headers.</td>
</tr>
<tr>
<td><img src="image" alt="Mute Button" /></td>
<td></td>
<td><strong>MUTE</strong>: This button turns the channel off and on for playback. Mute buttons on the Desktop Console correspond with the Mute buttons on the Fairlight page Mixer and track headers.</td>
</tr>
</tbody>
</table>

Desktop Console with active Mute, Solo, and Select buttons in the fader channel strips

Optional HDMI monitor display showing track status for the channels in Strip mode
Channel Control Knobs

Each channel strip includes a touch-sensitive multi-function encoder knob with realtime graphical and numeric feedback of the current position on the adjacent LCD screen. The Channel Control knobs default to left-right (L/R) Pan controls and offer smooth precision rotary adjustments. The handy touch-control of these knobs is perfect for recording Pan automation because you can start recording data the instant you touch a knob and stop when you release it. Knob settings are mirrored in the corresponding Mixing window in DaVinci Resolve.

Use modifier keys for enhanced control knob functionality:

<table>
<thead>
<tr>
<th>Channel Knob</th>
<th>Hold</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>SHIFT</td>
<td>Hold SHIFT in conjunction with the knob for refined incremental control.</td>
</tr>
<tr>
<td></td>
<td>ALT</td>
<td>Hold ALT to switch from L/R Pan to front-back (F/B) panning and corresponding feedback on the LCD screen.</td>
</tr>
<tr>
<td></td>
<td>CTL</td>
<td>Hold CTL and touch any knob to reset the designated parameter to the default value.</td>
</tr>
</tbody>
</table>

LCD Screens

At the top of each channel strip you’ll find a high-resolution LCD color display that shows the Track or Bus name, color, metering up to 7.1.4 wide, bus assignments, and panning if in Default strip mode. The information displayed for each track directly correlates with the Fairlight page Mixer and track headers.

NOTE: The LCD screens display different information based on the current Control mode in use on the Fairlight Desktop Console. You’ll find detailed images of the other Control modes later in this chapter.
Automation Buttons

The Fairlight Desktop Console includes automation controls designed to allow the operator to record every static and dynamic parameter change you make in the process of balancing, mixing, and sweetening the overall sound of your timeline in the Fairlight page. The six Automation buttons offer the same automation controls available in the Fairlight page Automation toolset.

Automation buttons include:

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ON</strong></td>
<td>Use this button to turn automation mode on and off.</td>
</tr>
<tr>
<td><strong>STOP</strong></td>
<td>Toggles the On-Stop mode through Event, Hold, or Return.</td>
</tr>
<tr>
<td><strong>MODE</strong></td>
<td>This button toggles between Write or Trim action.</td>
</tr>
<tr>
<td><strong>TCH</strong></td>
<td>The Touch button toggles the automation touch mode through three recording options: Off, Latch, and Snap.</td>
</tr>
<tr>
<td><strong>ENAB</strong></td>
<td>Hold this button while touching any fader, pan knob, or Mute button to enable/disable that parameter for automation recording. Additionally, the User button Mix User set offers additional enables in the Enables Quick Menu layout.</td>
</tr>
<tr>
<td><strong>CURV</strong></td>
<td>Hold the Curve button and touch any fader strip control on a selected track to show its parameter’s automation curve on the selected channels in the Fairlight page Timeline.</td>
</tr>
</tbody>
</table>

Automation writing fader automation data on the A3 track.
Automation mirroring the Desktop Console, writing fader automation data on the A3 track

Channel Buttons

One way the Fairlight Desktop Console is able to pack enhanced functionality with minimal Channel strip buttons, is to repurpose the SEL button as needed for different workflows. Even in default mode, the channel select button (SEL) can easily be used as a switch for common strip mode functions. That’s where the Channel buttons come into play. The Channel buttons temporarily assign channel-specific button functions from the Fairlight page track headers and Mixer to the Channel Select button (SEL). When engaged, the Channel buttons turn the SEL button into a toggle switch that mirrors its functional counterpart on the Fairlight page.

These functional override Channel buttons include ENAB, AUTO, and REC. Plus, there is an A/B channel button, as well as Left and Right Bank buttons for mapping and toggling through banks of tracks.

The AUTO, REC, and ENAB channel SEL switch modifier buttons can be latched for extended use or engaged via momentary press, so you can quickly use the modified SEL switch and release to return to the task at hand. Pressing any of the focus mode Control buttons will automatically unlatch the Channel modifier button and reassign the SEL switches accordingly.
Channel buttons include:

<table>
<thead>
<tr>
<th>Key</th>
<th>Hold</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTO</td>
<td></td>
<td><strong>AUTO:</strong> This button modifies the SEL buttons to switch the channel in and out of automation writing and can be used on-the-fly to punch in and punch out during playback. This functions the same as clicking the Automation Write button on the track header or channel strip in the Fairlight page Mixer.</td>
</tr>
<tr>
<td>REC</td>
<td></td>
<td><strong>REC:</strong> Latch this button to assign the SEL switches as Arm buttons to quickly arm tracks for recording.</td>
</tr>
<tr>
<td>ENAB</td>
<td></td>
<td><strong>ENAB:</strong> Use this SEL button modifier to temporarily override the Focus mode SEL switches and enable them to be used as Track Select buttons.</td>
</tr>
<tr>
<td>A/B</td>
<td></td>
<td><strong>A/B:</strong> This A/B switch is not operational at this time.</td>
</tr>
<tr>
<td>BNK &gt;</td>
<td></td>
<td><strong>BNK &gt;:</strong> Bank Forward banks the faders to the right in groups of 12, or the next 12 channels or buses in the Timeline from your starting position. Hold SHIFT while pressing this button to bank the faders one at a time. You can use this SHIFT banking option to create custom fader banks.</td>
</tr>
<tr>
<td>BNK &gt;</td>
<td>SHIFT</td>
<td>Hold CTL and press the BNK &gt; button to locate the first bus.</td>
</tr>
<tr>
<td>BNK &gt;</td>
<td>CTL</td>
<td>Hold a fader while pressing the BNK &gt; button to leave that channel on that strip.</td>
</tr>
<tr>
<td>Key</td>
<td>Hold</td>
<td>Description</td>
</tr>
<tr>
<td>-----</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td><code>&lt; BNK</code></td>
<td></td>
<td><code>&lt; BNK</code>: Bank Back banks to the previous set of 12 tracks or buses. Hold SHIFT while pressing this button to bank the faders one at a time in the relative direction. Hold CTL and press the <code>&lt; BNK</code> button to locate the first track. Hold a fader while pressing the <code>&lt; BNK</code> button to leave that channel on that strip.</td>
</tr>
</tbody>
</table>

**TIP:** When working with high track counts, you can quickly jump to the last track/first bus by pressing CTL+ `< BNK` >. Once you have located the first bus, you can press `< BNK` to bank through your right-most tracks 12 at a time from the last track toward the first. To jump back to the first tracks, press CTL+ `< BNK`.

### Monitoring Controls

The Monitoring controls on the right side of the Fairlight Desktop Console is where you control the listening levels for the Control Room and Studio speakers. These controls default to Control Room monitor levels and can be changed at any time using the Monitor knob and buttons. Hold the CANS button to re-target all of the Monitoring controls for studio monitoring.

![Fairlight Desktop Console Monitoring controls](image)

**Monitoring Knob**

Use this knob anytime during recording, playback, or mixing to adjust the Control Room or Studio listening levels. Changes to the Control Room levels are reflected in the DaVinci Resolve Timeline monitoring controls located in the upper-right corner of the Edit page and Fairlight page Timelines. If you are using an optional HDMI Monitor, you’ll see the monitoring controls in the upper-left corner of the screen. Sometimes the monitoring environment must be set to a standard level and not changed. This is called Fixed Level monitoring. For example, if your control room has been calibrated with a sound pressure level (SPL) meter, you will probably want to set a Fixed monitoring level. When fixed, the Control Room knob has no affect on the monitoring levels. When Fixed Level monitoring is toggled on, the listening level meter in the upper-right of the Timeline GUI turns from green to blue.
Control Room monitoring controls include:

<table>
<thead>
<tr>
<th>Key</th>
<th>Hold</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DIM</td>
<td></td>
<td><strong>DIM:</strong> This button reduces the Control Room monitor volume by -15dB. Press to toggle Dim on or off. The DIM button state is mirrored in the DaVinci Resolve monitoring controls. When DIM is toggled on, the level slider in the onscreen monitoring controls turns yellow. Control Room levels automatically DIM during Studio talkback. Use the Monitoring knob to adjust the DIM level.</td>
</tr>
<tr>
<td>MUTE</td>
<td></td>
<td><strong>MUTE:</strong> Use this button to mute or unmute the Control Room monitors as well as turn on or off Fixed Level monitoring. Press to mute or unmute Control Room monitoring.</td>
</tr>
<tr>
<td>MUTE</td>
<td>CTL</td>
<td>Hold CTL and press Mute to switch on or off Fixed Level monitoring. When Fixed Level monitoring is switched on, the level slider in the onscreen monitoring controls turns blue.</td>
</tr>
<tr>
<td>MUTE</td>
<td>CTL + SHIFT</td>
<td>Hold CTL + SHIFT while turning the Monitoring Control Knob to adjust the fixed level.</td>
</tr>
<tr>
<td>SRC</td>
<td></td>
<td><strong>SRC:</strong> Use this button to toggle between the last two selected monitor sources. Holding this Source button along with the associated USER button selects a specific bus for monitoring. For example, if you Hold SRC and press USER 2, the monitoring will change to bus 2, while holding SRC and pressing USER 5 will change the monitoring to bus 5.</td>
</tr>
<tr>
<td>SPKR</td>
<td></td>
<td><strong>SPKR:</strong> This button toggles between the last two selected monitor sets. Holding this Speaker button and pressing the associated USER button selects the specific monitor set. The two default speaker sets are MAIN and NEAR. Holding SPKR and pressing USER 2 will switch to the NEAR monitoring set, and holding SPKR and pressing USER 1 will return the Control Room monitoring to the MAIN speaker set.</td>
</tr>
</tbody>
</table>

The Studio monitoring controls adjust the Studio monitoring circuit of a Fairlight accelerator card installed on your workstation. Hold the CANS button to target the monitoring controls for Studio monitoring.

Studio monitoring controls include:

<table>
<thead>
<tr>
<th>Key</th>
<th>Hold</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CANS</td>
<td></td>
<td><strong>Studio knob:</strong> Hold CANS to use this to dial the monitoring level of the speakers in the Studio.</td>
</tr>
<tr>
<td>DIM</td>
<td>CANS</td>
<td><strong>DIM:</strong> Hold CANS and press this button to reduce the Studio monitor volume by -15dB.</td>
</tr>
</tbody>
</table>
### Search Dial and Transport Controls

Some of the most useful controls on the Desktop Console are the search dial and transport buttons which function exactly as expected for a professional audio control surface. The search dial and surrounding transport buttons offer a complete set of transport commands designed to let you keep your hand in one position while you quickly navigate the Timeline from end to end or anywhere in between in seconds. Additionally, the dial can be used for focused timeline zooming and scrolling.

As a means of navigation, scrubbing, playback and zooming, the dial has four modes of operation that are initiated by the respective buttons located above and below the search dial.
Search dial operational modes include the following:

<table>
<thead>
<tr>
<th>Key</th>
<th>Hold</th>
<th>Description</th>
</tr>
</thead>
</table>
|   |  | **Jog**: This is the search dial’s default operational mode.  
In Jog mode, the playhead movement is contingent on the movement of the dial, so you can freely jog forward or in reverse at variable speeds while turning the dial and stops when the dial is released. Jog mode is often used to scrub a specific area to focus on audible cues for mixing, editing, and trimming.  
If the transport is stopped, press Play to engage the dial. Then turn the dial to jog.  
If the “Always On” option is checked in System Preferences, the jog dial unconditionally controls the transport immediately whenever you move the dial, even during playback. This “always on” convenience does not affect the transport during recording, Shuttle or Scroll operations.  
Hold CTRL while turning the jog dial to increase playhead movement. Release CTRL to return to standard jog speed. |
|   |  | **Shuttle**: In Shuttle mode, turning the dial forward (clockwise) or back (counter-clockwise) starts playback in fast forward or rewind at variable speeds based on the amount the dial is turned. Releasing the dial while shuttling forward or back will continue constant playback at the current speed until the playhead reaches the beginning or end of the project.  
In Shuttle mode, holding CTRL while turning the jog dial increases the speed 8X. |
|   |  | **Scroll**: In Scroll mode, the playhead position is controlled by the dial to quickly move earlier or later in the Timeline.  
Hold CTL while scrolling to move the playhead from the project start (first frame) to the project end (last frame) in a single rotation of the dial. |
Zoom: The Zoom button, which looks like a magnifying glass, is used in combination with the dial and modifier keys to offer numerous quick zooming and scaling options while you work.

The Zoom button can also be combined with the User buttons to show and map the onscreen User Mapping menu.

Hold Zoom and turn the dial to change the horizontal scale of the Timeline on the computer screen.

Hold CTL + Zoom and turn the dial to change the vertical scale of the Timeline, which in turn changes the height of the tracks and the subsequent number of tracks visible in the Timeline.

Hold Shift + Zoom and turn the dial to move the current track selection to higher or lower tracks.

Double-press Zoom to zoom your entire program to fit within the current visible width of the Timeline. Double-press Zoom again to toggle back to the previous zoom level.

Zoom + any User button toggles on or off the User Mapping menu onscreen. The User Mapping menu is a 2x3 grid that changes in real time by using the ALT and CTL modifier buttons.

NOTE: Horizontal scaling zooms around the playhead, while vertical zooming focuses on the active selected track.

In addition to the jog dial, you’ll find a set of five standard transport control buttons that can be used for recording, playback, and navigation.

The transport buttons include:

<table>
<thead>
<tr>
<th>Key</th>
<th>Hold</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Record Button" /></td>
<td></td>
<td><strong>Record</strong>: When used in conjunction with Play starts and stops, recording switches the transport in and out of record mode for the record-enabled channels.</td>
</tr>
<tr>
<td><img src="image" alt="Fast Reverse Button" /></td>
<td></td>
<td><strong>Fast Reverse</strong>: Depending on Control Panel options in System Preferences, this button either places the transport into rewind or jumps left.</td>
</tr>
<tr>
<td><img src="image" alt="Fast Forward Button" /></td>
<td></td>
<td><strong>Fast Forward</strong>: Depending on Control Panel options in System Preferences, this button either places the transport into fast forward or jumps right.</td>
</tr>
</tbody>
</table>
### Key Hold Description

<table>
<thead>
<tr>
<th>Key</th>
<th>Hold</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎧</td>
<td></td>
<td>Stop: This button stops playback or recording.</td>
</tr>
<tr>
<td>🎧</td>
<td></td>
<td>Play: Places the transport dial into the default jog mode. Press again starts playback.</td>
</tr>
<tr>
<td>🎧</td>
<td>⌘</td>
<td>Hold CTL and press Play to locate to the last play point and play again.</td>
</tr>
</tbody>
</table>

### Control Panels Options in DaVinci Resolve Preferences

The Control Panels preferences offer several options to customize your Desktop Console transport controls, including:

- **Use Fast Forward and Rewind as Jump**: Check this option if you want use the Fast Forward and Rewind keys to jump to clips, fades, markers, or transients on the selected tracks. Choose the Jump navigation options in the Timeline Options menu in the Fairlight Page toolbar.

- **Always in Jog**: When this option is On, any movement of the dial will cause the transport to switch to Jog. Always in Jog affects the dial when the transport is not in motion and does not override Shuttle, Scroll, or Record operations.

**TIP**: Always in Jog is handy while previewing new material, editing, arranging, and organizing tracks. This is great because you can grab the dial and instantly navigate. However, when performing complex mixes and writing automation, it’s a good idea to turn this option off, so you can’t accidentally bump or nudge the dial while you work.

---

Audio Console options in System Preferences

Timeline Options menu with navigation options, including: clips, fades, markers, and transients
**Modifier and Undo Buttons**

The modifier buttons are conveniently located in the lower-left corner of the console, just where you are accustomed to finding them on a standard computer keyboard. These versatile buttons add functionality to other controls throughout the console. There’s also an Undo button that you can use as often as needed while you work.

![Modifier and Undo buttons](image)

**Modifier and Undo keys include:**

<table>
<thead>
<tr>
<th>Key</th>
<th>Hold</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="SHIFT" /></td>
<td><strong>SHIFT</strong>: The Shift modifier key is used in conjunction with numerous other buttons and controls to expand functionality. For example, hold Shift while turning a Channel knob for refined control. Hold Shift + Zoom while turning the dial to move the current selection to higher or lower tracks.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="ALT" /></td>
<td><strong>ALT</strong>: Use the ALT button to reveal alternative parameters or functions. A few examples of ALT modifier functions include:</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="ALT" /></td>
<td>Hold ALT to change the Strip mode Pan control knob function from left/right panning to front/back panning.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="ALT" /></td>
<td>Hold ALT and press Solo to toggle Solo Safe status on or off.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="CTL" /></td>
<td><strong>CTL</strong>: The Control button is the most commonly used modifier button and is the easiest to find without looking, since it is the first button in the lower-left corner of the console. A few examples of the CTL button’s uses include:</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="CTL" /></td>
<td>Hold CTL while touching any Channel Control knobs or faders to reset them to the default value.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="CTL" /></td>
<td>Hold CTL while using the search dial to increase speed.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="CTL" /></td>
<td>Hold CTL and Zoom while turning the dial to zoom vertically.</td>
<td></td>
</tr>
</tbody>
</table>
Key Hold Description

<table>
<thead>
<tr>
<th>Key</th>
<th>Hold</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNDO</td>
<td>CTL</td>
<td>Hold CTL and press UNDO to REDO one step.</td>
</tr>
<tr>
<td>&lt;</td>
<td>CTL</td>
<td>Hold CTL and press Left Arrow to mark an In point.</td>
</tr>
<tr>
<td>&gt;</td>
<td>CTL</td>
<td>Hold CTL and press Right Arrow to mark an Out point</td>
</tr>
<tr>
<td>UNDO</td>
<td>UNDO</td>
<td><strong>UNDO:</strong> Use this button anytime you need to go back and undo your last step. This works as expected, no surprises here. Just a reliable means of taking a step back if you make a mistake or get ahead of yourself and perform an operation you didn’t intend. And you can also hold CTL and press UNDO to REDO a step.</td>
</tr>
</tbody>
</table>

**Arrow Keys**

These Arrow keys serve a myriad of uses during your post production workflows, from moving the playhead one frame left or right with the Left and Right Arrows, to jumping clip to clip up or down the Timeline with the Up and Down Arrows. The Fairlight Desktop Console includes a set of four arrow keys that you can use for standard arrow movement, as well as console-specific operations.

**Arrow buttons, clockwise from the top, include:**

<table>
<thead>
<tr>
<th>Key</th>
<th>Hold</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>▲</td>
<td></td>
<td><strong>Up Arrow:</strong> Use this button to move a selection up in a list, Media Pool or sound library. The Up Arrow is also used for navigation to move the playhead to the next clip, fade, marker, or transient in the Timeline. These “jump to” navigation functions are determined by the Navigation options in the Timeline Options menu.</td>
</tr>
<tr>
<td>▲</td>
<td>SHIFT</td>
<td>Hold Shift and press Up Arrow to move forward to the next marker.</td>
</tr>
<tr>
<td>Key</td>
<td>Hold</td>
<td>Description</td>
</tr>
<tr>
<td>-----</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>⏯</td>
<td></td>
<td><strong>Right Arrow:</strong> Used to move the playhead forward one frame or one second at a time. Press Right Arrow to move the playhead one frame forward.</td>
</tr>
<tr>
<td>⏯</td>
<td>SHIFT</td>
<td>Hold Shift and press Right Arrow to move one second forward.</td>
</tr>
<tr>
<td>⏯</td>
<td>CTL</td>
<td>Hold CTL and press Right Arrow to mark an Out point.</td>
</tr>
<tr>
<td>⏯</td>
<td></td>
<td><strong>Down Arrow:</strong> Use this button to move a selection down in a list, Media Pool or Timeline. The Down Arrow is also used for navigation to move the playhead to the previous clip in the Timeline. Shift plus the Down Arrow button moves to the previous marker.</td>
</tr>
<tr>
<td>⏯</td>
<td></td>
<td><strong>Left Arrow:</strong> Used to move the playhead back one frame or one second at a time. Press Left Arrow to move the playhead one frame back.</td>
</tr>
<tr>
<td>⏯</td>
<td>SHIFT</td>
<td>Hold Shift and press Left Arrow to move one second back.</td>
</tr>
<tr>
<td>⏯</td>
<td>CTL</td>
<td>Hold CTL and press Left Arrow to mark an In point.</td>
</tr>
</tbody>
</table>

**NOTE:** Once you set an In or Out point in the Timeline, you can use the dial to extend the selected range. To clear the In and Out points (Range), press Option-X on the computer keyboard.

**User Buttons**

The six sequentially numbered User buttons are user-defined quick keys that change operation depending on the mode and function in combination with other button groups. For example, a re-recording mix engineer performs different tasks than the ADR engineer, so each professional would set up the User buttons to give them easy access to the functions and modes they need most for their workflow. User buttons can be used alone, or in combination with other buttons for specific functions and workflows.

At the time of this writing, the User buttons are mapped to 6 User sets, including Edit, Mix, Record, Views, Setup, and a blank unassigned User set. Each of the 6 User Sets is then mapped to additional menu layouts each with six menu options related to that set. User button quick menus offer fast mouse-free two-handed editing options, like those available in the Fairlight Audio Editor. The difference is that you look at the Quick Menu dialog on the computer screen to see which functions are assigned to the User buttons instead of the labels on the console keys.

The current User Button Quick Menus are an early incarnation of this feature and will undergo visual GUI improvements and enhanced functionality in future updates.
The Quick Menu is a dialog in the Fairlight page user interface that you can show or hide by holding Zoom and pressing any of the User buttons. What makes the Quick Menu dialog unique is its 2x3 grid design containing six user-defined buttons that can be toggled from the corresponding User buttons on the Desktop Console. To select an option from the Quick Menu, once you’ve chosen the desired USER SET page, you simply press the User button that corresponds to the function you need. This innovative physical button-to-dialog button relationship makes it easy to learn the quick menus and functions as well as build lightning-fast muscle memory to trigger the actions while you work.

**NOTE:** The Quick Menu dialog can be moved anywhere on the Fairlight page interface, so you can see it at a glance, without obstructing view or workflow.

**User Button and Quick Menu Functional Overview**

The default Quick Menu layout is Edit, however you can change the layout anytime by pressing the appropriate modifier keys along with the corresponding User button. For ease of operation, you use the Zoom button to show or hide the Quick Menu, and the modifier keys to change layouts. It requires two modifier keys (ALT+CTL) to change to a different User set, and one modifier (ALT) to select a different submenu layout within the current User Set. This is similar to using a mouse to open a submenu in the Fairlight Page interface, or pressing Menu keys to reveal Menu Option keys on the Fairlight Audio Editor. Once you have selected a Quick Menu layout, such as Edit - Basic, you can then engage any of the six actions by pressing the corresponding User button. User Button layouts are identified by the name in the Quick Menu header. Hyphenated names represent the current User Set.
followed by the submenu layout. For example, EDIT - BASIC identifies the Edit User Set showing the Basic submenu layout of six different Edit actions that can be engaged by pressing the corresponding User button.

– Press Zoom plus any User button to Show the floating Quick Menu dialog on the Fairlight Page interface

Six User buttons and the EDIT - BASIC User Set

– Once the Quick Menu dialog is showing, it will remain on screen until you press Zoom plus a User button to close. You can also close the Quick Menu dialog by clicking the Close (x) button on the dialog.

– The Quick Menu retains the most recently used layout whenever you show or hide it.

– Press CTL + ALT to show the six User Sets including: EDIT, MIX, RECORD, VIEWS, SETUP, and BLANK.

Press CTL + ALT to view the six User Sets

– To choose a User Set, continue holding the CTL + ALT modifiers with one hand and press the User button that corresponds with the User Set you wish to use with the other hand. For example: Hold CTL + ALT to show all 6 User Sets, then press User Button 1 to show the Edit User Set. Once you have selected the Edit User Set, you can release the CTL + ALT keys.

– Press ALT to show the submenu layouts for the current User Set. In this example, there are five EDIT submenu layouts mapped to the first five buttons.
NOTE: Quick Menu buttons that are blank have not been mapped to a function. The Edit Blank layout is the default User set when engaging the User Button layouts for the first time. With this layout, none of the User buttons are assigned to actions, and therefore, new users can avoid accidentally applying editing actions to the Timeline.

– To choose an option from the Quick Menu, press the User button in the same position. For example, in the EDIT User Set, the CLIP submenu layout is in the same position as User 4, therefore, you press User 4 to choose the EDIT-CLIP layout. The EDIT-CLIP layout, in turn, offers three clip-based actions that can be engaged by pressing the corresponding User button. No modifier keys are needed to choose an option from the current user set layout, hence the name Quick Menu.

– To quickly change to a different submenu options layout in the same Quick Menu User Set, press ALT to show the submenu option sets, then press the User button for the desired layout. In this example, to change from the EDIT-CLIP options to the EDIT-BASIC options, press ALT to see the different submenu options, and User 1 to choose the Basic option in the 1 position.

– To engage the options currently mapped to the Quick Menu, press the corresponding User button. For example, in the Edit - Basic Quick Menu, press User 1 to Cut, User 2 to Copy, User 3 to Paste, User 4 to Split, User 5 to Trim Head, and User 6 to Trim Tail.

– To hide the Quick Menu dialog, Press Zoom plus any User button.
NOTE: Once you incorporate User buttons and Quick Menu options into your everyday workflows, you’ll find that switching between layouts and engaging options is as effortless as using keyboard shortcuts or right-click menu options in the DaVinci Resolve interface.

EDIT User Set

There are five Edit menu layouts: Blank, Basic, Level, Nudge, and Clip. Press ALT to show the different Edit menu layouts in the Quick Menu dialog. Press the associated User button to choose an Edit layout. In this case, the Blank button is in the top-left grid position, and the Edit Basic layout is in the User 2 position. Pressing User 2 button would select the Edit Basic layout. Once selected, the button in the Quick Menu dialog is highlighted. Release Alt to show the selected Quick Menu layout with button-menu options related to specific Editing tasks. Similar to working with the Fairlight Audio Editor, the options on the Edit-Basic layout change from “Clip” to “Range” if a range is active in the Timeline. Additionally, the Shift and Control modifier keys offer secondary functions.
Edit Quick Menu layouts and button options include:

- **BLANK**: This default layout has no actions assigned to the six User buttons. This is to prevent new users from accidentally editing their projects via User buttons.

- **BASIC**: Use this button layout to place common fast-editing actions at your fingertips. Use the dial and transport controls with your right hand for navigation and selection, while quickly choosing editing actions via the User buttons with your left hand.

- **Cut Clip/Cut Range**: Press User 1 to cut the currently selected material and place it in the clipboard. The cut material maintains its relationship to the playhead in a semi-transparent form, so you can see exactly where it will be pasted as you move the playhead or selection to a new location. To Paste the clip, press the User 3 button. Alternatively, you can cut and paste clips on-the-fly by holding the User 1 button to cut, continue playback or move the playhead until the semi-transparent clip is in position, then release the User 1 button to paste.

- **Copy Clip/Copy Range**: Press User 2 to copy the currently selected material to the clipboard. Move the semi-transparent copied clip to position, then press the User 3 button to paste. Since this is a standard clipboard editing tool, you can paste additional copies of the material by pressing User 2 again. If you’d rather copy and paste during playback, press and hold User 2 to copy the selection and release to paste.

- **Paste**: Press User 3 to paste the current clipboard material into the Timeline based on the selected tracks and playhead position.

- **Split Clip/Split Range**: Press User 4 to split the clip or range at the playhead position, creating a new edit point between two clips or at the range boundaries. The split editing action is based on the selected tracks and playhead position.

- **Trim Head**: Press User 5 to erase the portion of the selected clip to the left of the playhead. Alternatively, press and hold User 5 while the playhead is over a selected clip to reveal all of the clip’s handles (unused frames) to the left of the playhead. While continuing to hold User 5, move the playhead along the extended clip to find a new starting frame. Release User 5 to trim the head of the clip to the new playhead position.

- **Trim Tail**: Press User 6 to erase the portion of the selected clip to the right of the playhead. Alternatively, press and hold User 6 while the playhead is over a selected clip to reveal all of the clip’s handles (unused frames) to the right of the playhead. Continue holding User 6 while moving the playhead to the last desired frame. Release User 6 to trim the clip’s tail to the new playhead position.

**NOTE**: Although you can manually click to select individual clips with a mouse while editing with a standard keyboard. Fairlight Console audio editing is centered around automatic clip selection based on the selected tracks and playhead position for fast, on-the-fly workflows. As the playhead passes over a clip on a selected track, that clip is automatically selected, thus allowing effortless Cut, Copy, Paste, and Trim functions at the touch of a button.
– **LEVEL:** As the name suggests, the options in this User Button menu are all based on controlling the selected clip’s level. Like the Edit-Basic options, the Edit-Level options are based on selection and playhead position. Additionally, modifier keys offer more User Button menu options. In most cases these expanded options are directly related to the default menu option so that you can quickly fine tune your actions as you go.

  - **Clip Level:** Hold User 1 and turn the dial to increase or decrease the selected clip’s level. This affects the selected clip beneath the playhead and can be performed while the transport is stopped or during playback as the playhead passes over a clip in the selected track.

  - **Display Level:** Hold User 1 + CTL and turn the dial to increase or decrease the waveform zoom level in the selected tracks. Changing the waveform display level does not change the volume levels of the affected clips or tracks.

  - **Fade Head:** Press User 3 to apply a fade from the playhead to the head of the selected clip.

  - **Head Shape:** Hold Shift + CTL to show the Head Shape menu option. Press User 3 and turn the dial to change the shape of the fade at the head of the clip.

  - **Head X-Level:** Hold CTL to show the Head X-Level menu option. Press User 3 and turn the dial to change the level curve of the fade or crossfade at the head of the clip beneath the playhead.

  - **Head X-Point:** Hold Shift to show the Head X-Point menu option. Press User 3 and turn the dial to change the height of the crosspoint in the crossfade at the head of the clip beneath the playhead.

  - **Fade Tail:** Press User 4 to apply a fade from the playhead to the tail of the selected clip.

  - **Tail Shape:** Hold Shift + CTL to show the Head Shape menu option. Press User 4 and turn the dial to change the shape of the fade at the head of the clip.

  - **Tail X-Level:** Hold CTL to show the Head X-Level menu option. Press User 4 and turn the dial to change the level curve of the fade or crossfade at the head of the clip beneath the playhead.

  - **Tail X-Point:** Hold Shift to show the Head X-Point menu option. Press User 4 and turn the dial to change the height of the crosspoint in the crossfade at the head of the clip beneath the playhead.

  - **Top Layer/All Layers:** Press User 5 to toggle between Top Layer and All Layers. When set to Top Layer, any clip level or editing actions that you apply to a stack of overlapping clips in audio track layers will only be applied to the top clip. When set to All Layers any editing actions applied to a clip with overlapping audio clips in layers will be applied to the entire stack of clips beneath the playhead. This function works, even when audio track layers are hidden.

– **NUDGE:** This User Button menu layout focuses on refining the positions and timing of the clips.

  - **Nudge Left:** Press User 1 to move the selected clip one frame at a time to the left.

  - **Nudge Right:** Press User 2 to move the selected clip one frame at a time to the right.

  - **Media Left:** Hold CTL to show the secondary option and Press User 1 to move the media within the selected clip one frame at a time to the left without chaining the clip duration or position.

  - **Media Right:** Hold CTL to show the secondary option and Press User 2 the move the media within the selected clip one frame at a time to the right without chaining the clip duration or position.

– **CLIP:** Use this menu layout for quick control of the selected clip.

  - **Toggle Mutes:** Press User 1 to mute (disable) the selected clip or clips beneath the playhead on selected tracks. Press User 1 again to un-mute (enable) the clip or clips.

  - **Reverse Clip:** Press User 2 to reverse the clip beneath the playhead on the selected track. Press User 2 again to reverse again, so it plays forward.

  - **Inspect Clip:** Press User 3 to show the Inspector panel in the Fairlight Page interface. Press User 3 again to hide the Inspector.
MIX User Set

There are 5 Mix menu layouts for working with mix automation: Basic, Punch, Preview, Copy/Paste, and Enables. Press ALT to show the different Mix menu layouts in the Quick Menu dialog. Press the associated User button to choose a Mix options layout.

Mix Quick Menu layouts include Basic, Punch, Preview, Copy/Paste, and Enables.

Mix-Basic Quick Menu layout

Mix-Punch Quick Menu layout

Mix-Preview Quick Menu layout

Mix-Copy/Paste Quick Menu layout

Mix-Enables Quick Menu layout

Mix - unmapped - User-defined Quick Menu layout

Mix Quick Menu layouts and buttons include:

- **BASIC**: Use this submenu options layout to access common functions while previewing or working with previously recorded automation data.

- **All Read**: Press User 1 to get controls out of Write or Preview before the transport starts moving.

- **Copy Mix**: Press User 3 to copy all automation data within the selected range to the clipboard. This is the first step in copying automation data from one track or bus to another.

- **Paste Mix**: Press User 4 to paste data from a copied automation range into the range selection in the Timeline, based on enabled parameters in the Automation toolset. For example, if you copy a range of automation from the MUSIC 1 track, all of the automation data within that range is copied to the clipboard. However, if only the Fader and Pan parameters are enabled in the Automation toolset, only those automation curves will be pasted to the selected range on the Music 2 track in the Timeline.

- **Erase Mix**: Press User 5 to erase the automation data within the selected range.
– **PUNCH**: As the name suggests, the options in this Mix layout offer range-based options to control when and where new automation data is written into an existing mix.

  – **Auto In**: Press User 1 to start an automation pass, pre-rolling, then punching In at the range start point.
  
  – **Auto Out**: Press User 2 to start an automation pass, pre-rolling, then punching in at the range Out point.

  – **Punch In**: Press User 3 to switch automation from Preview or Read to Write during playback. Once you Punch In, all enabled parameters will remain in Write mode until you stop playback or press User 4 to Punch Out.

  – **Punch Out**: Press User 4 to stop writing Automation and enter Read mode during playback.

  – **Auto Punch**: Press User 5 performs an automation pass, pre-rolling, then punching In and Out at the range start and end points.

  – **Join Mix**: Press User 6 to punch into Automation Write with all enabled parameters during playback, with exactly the parameter values you had when Write last stopped. This is handy for making a second pass and finessing a section you just mixed.

– **PREVIEW**: This Mix menu layout offers Preview-related mix options that allow you to suspend Automation Read or Write for enabled controls while you find new settings for them.

  – **Preview**: Press User 1 to switch on the Preview automation controls and audition new settings for the enabled controls without changing the recorded automation data.

  – **Fill Range**: Press User 3 to perform and instant automation pass, writing the current values of all parameters that are in Preview mode through the range.

  – **Glide Range**: Press User 4 to perform an instant automation pass that writes a glide through the range from the value at the start of the range to the current control level of the parameter, for all parameters that are in Preview mode.

  – **Punch In**: Press User 5 to switch from Preview to Write mode starting at the point where you press Punch In and applying the current control levels until you stop playback or press User 6 to Punch Out.

  – **Punch Out**: Press User 6 to stop writing automation and return to Preview mode during playback.

– **COPY/PASTE**: Use this Mix menu layout to quickly copy and paste automation from one range to another.

  – **Copy**: Press User 1 to copy all automation data within a range.

  – **Paste All**: Press User 2 to paste all copied automation data to a range.

  – **Paste EQ**: Press User 3 to paste only the copied EQ automation data to a range.

  – **Paste Aux**: Press User 4 to paste only the copied Aux buss automation data to a range.

  – **Paste Dyn**: Press User 5 to paste only the copied Dynamics automation data from the built-in Fairlight Dynamics processing on each track to a range. Dynamics include: Expander, Gate, Compressor, and Limiter automation.

  – **Paste Plugs**: Press User 6 to paste only the copied plug-ins automation data to a range.

– **ENABLES**: Use this menu layout to quickly enable or disable automation recording for specific parameter sets.

  – **Write EQ**: Press User 1 to enable or disable EQ automation.

  – **Write Comp**: Press User 2 to enable or disable Comp button automation.

  – **Write Gate**: Press User 3 to enable or disable Gate automation.
– **Write Limiter**: Press User 4 to enable or disable Limiter button automation.
– **Write Aux**: Press User 5 to enable or disable Aux automation.
– **Write Plugins**: Press User 6 to enable or disable Plug-in automation.

**NOTE**: The Mix user set and subsequent Quick Menu options are only functional while the Automation toolset is On and showing in the Fairlight Page user interface. Press the On button in the Automation area at the top of the Desktop Console to toggle Automation On or Off.

### RECORD User Set

This user set offers the same recording options that are available in the Fairlight Audio Editor for both Manual and ADR recording. There are four Record Quick Menu layouts: Manual, Rate Clip, ADR List, and ADR Record.

**Record Quick Menu layouts include Manual, Rate Clip, ADR List, and ADR Record.**

Record-Manual Quick Menu layout

Record-Rate Clip Quick Menu layout

Record-ADR List Quick Menu layout

Record-ADR Record Quick Menu layout

**Record Quick Menu layouts and buttons include**:

– **MANUAL**: Use this button layout to place common fast-editing actions at your fingertips. Use the dial and transport controls with your right hand for navigation and selection, while quickly choosing editing actions via the User buttons with your left hand.

– **Record Here**: Press User 1 to initiate the Record Here action from the current playhead position. When you engage Record Here, the playhead goes back the pre-roll duration, then punches into Record at the location where you issued the command.

– **Record Again**: Press User 2 to repeat the last recording you made, both entry and exit, whether it was manually or automatically punched in.

– **Record Clip**: Press User 3 to initiate the Record Clip manual recording method. After pre-roll, the playhead punches in and out to match the duration of the clip under the playhead on the selected track. If no clip is beneath the playhead, the transport moves forward to the next clip in the track and records there.
– **Record Range**: Press User 4 to record the current range. With this manual recording method, the playhead includes a pre-roll and punches into Record at the Range In point, and then punches out at the Range Out point.

– **Punch In Again**: Press User 5 to engage Punch Again recording. Punch Again pre-rolls, then enters record at the exact same place as last time, whether it was manually or automatically activated. When entering this record operation, you still need to manually Punch Out. This allows you to get the same start point for recording but with a manual exit.

– **Rec Head**: Press User 6 to enter the Record Head method, which pre-rolls, then starts recording at the head of the first clip to come beneath the playhead in the selected track. When entering this record operation, you still need to manually Punch Out.

– **RATE CLIP**: As the name suggests, the options in this User Button menu are all based on rating the ADR recordings from 1-Star (*) to 5-stars (*****). These ratings appear in the ADR Record panel Take list after each recorded take.
  
  – ****: Press User 1 to mark a 1-star rating on the selected take.
  
  – ****: Press User 2 to mark a 2-stars rating on the selected take.
  
  – ****: Press User 3 to mark a 3-stars rating on the selected take.
  
  – ****: Press User 4 to mark a 4-stars rating on the selected take.
  
  – *****: Press User 5 to mark a 5-stars rating on the selected take.
  
  – **Unrated**: Press User 6 to remove star ratings.

– **ADR LIST**: This ADR recording layout offers actions available in the ADR List panel. These actions are used for selecting and setting ADR cues.
  
  – **Prev Cue**: Press User 1 to select the previous cue in the Cue list.
  
  – **Next Cue**: Press User 2 to select the next cue in the Cue list.
  
  – **Set Cue In**: Press User 3 to set the current Timeline In point as the Cue In.
  
  – **Set Cue Out**: Press User 4 to set the current Timeline Out point as the Cue Out.
  
  – **Edit Dialog**: Press User 6 to highlight the text field and active text cursor in the ADR List panel so that you can type or edit the text for the current cue.

– **ADR RECORD**: Use this this ADR recording layout for rehearse and record options available in the ADR Record panel.
  
  – **Prev Cue**: Press User 1 to select the previous cue in the Cue list.
  
  – **Next Cue**: Press User 2 to select the next cue in the Cue list.
  
  – **Play Cue**: Press User 3 to play the currently selected take from the Take list (described below). If no take is selected, the most recently recorded one on top is played.
  
  – **Rec. Cue**: Press User 4 to initiate recording of the cue to the specified audio track, with cue beeps and video streamer cues.
  
  – **Rhrse Cue**: Press User 5 to rehearse the selected cue. This runs the section of the Timeline specified by a cue without actually recording anything, giving the talent an opportunity to run through their dialog and practice their timing and delivery. Beeps and on-screen streamers are not played during a rehearsal.
  
  – **Edit Dialog**: Press User 6 to highlight the text field and active text cursor in the ADR List panel so that you can type or edit the text for the current cue.
Views User Set

This user set offers quick access to view options and track zoom views that can be toggled on or off as needed while you work. There are two View Quick Menu layouts: Misc and Tracks.

**Views Quick Menu layouts** include Misc and Tracks.

**Views-Misc Quick Menu layout**

**Views-Tracks Quick Menu layout**

**Views Quick Menu layouts and buttons include:**

- **Misc:** Use this button layout to quickly show or hide common enhanced view features that are also available in the Setup mode layout on the Fairlight Audio Editor.

- **Toggle Layers:** Press User 1 to show or hide Audio Track Layers.

- **Video Scrolr:** Press User 2 to show or hide the Video Scroller.

- **Mixer Link:** Press User 3 to toggle on or off the Mixer Link feature. When Mixer Link is on, the Fairlight page mixer automatically scrolls to show the most recently selected track.

- **Tracks:** As the name suggests, the options in this User Button menu are all based on rating the ADR recordings from 1-Star (*) to 5-stars (*****). These ratings appear in the ADR Record panel Take list after each recorded take.

  - **1 Trk:** Press User 1 to vertically scale the Timeline tracks to show only the active track.
  
  - **2 Trks:** Press User 2 to vertically scale the Timeline to show two tracks, including the active track.
  
  - **4 Trks:** Press User 3 to vertically scale the Timeline to show four tracks, including the active track.
  
  - **8 Trks:** Press User 4 to vertically scale the Timeline to show eight tracks, including the active track.
  
  - **16 Trks:** Press User 5 to vertically scale the Timeline to show sixteen tracks, including the active track.
  
  - **All Trks:** Press User 6 to vertically scale the Timeline tracks to show all tracks.
SETUP User Set

This user set offers setup options that are available in the Fairlight Audio Editor setup mode. There are three Setup Quick Menu layouts: Misc, Jogger and Talkback.

Setup Quick Menu layouts include Misc, Jogger and Talkback.

Record-Manual Quick Menu layout

Record-Rate Clip Quick Menu layout

Record-ADR List Quick Menu layout

Setup Quick Menu layouts and buttons include:

- **Misc**: Use this button layout to quickly access common features that can enhance your Fairlight user experience.

- **Normal Solo/Solo Follow**: Press User 1 to toggle between Normal Solo and Solo Follow. When set to Normal Solo, pressing a Solo button on the Desktop Console or soloing a track on the Fairlight page results in the normal track solo behavior. When set to Solo Follow, solo is linked to track selection, so that any track you select or deselect will automatically solo or unsolo the corresponding track.

- **Undo**: Press User 2 to toggle between Undo Editor and Undo All. This functionality is a matter of operator preference. When set to the default, Undo Editor, tasks performed in Mix mode, including recording and editing automation data, will not be undoable. You can, however, simply record new mixing data to override the previous data as needed. Latching this key enables the Undo All mode, which in turn will undo all actions including automation applied in Mix mode.

- **Toggle Layers**: Press User 3 to on or off Audio Track Layers.

- **CTI:Moving/CTI:Fixed**: Press User 4 to choose whether the playhead (CTI) moves across the Timeline, or is fixed in place with the Timeline scrolling past.

- **Preview:Mon/Preview:Track**: Press User 5 to determine where preview monitoring goes when auditioning a sound and comes in handy when you need to preview a clip in the Media Pool or Sound Library. When toggled to Preview Track, you will put the track in Thru mode so it works like a live mic input and the sound you preview will be subject to the track’s fader levels, solo or mute state, and any processing applied to the track. If toggled to Preview Mon, the sound goes directly to the monitors without any processing or controls via the track’s channel strip in the mixer or console.

- **Write Paste**: Press User 6 to automatically set controls to write when pasting from one channel to another.
– **Jogger**: As the name suggests, the options in this User Button menu are all based on Jog settings for the Search Dial. These options are identical to those found on the Fairlight Audio Editor.

– **Gear:13**: Press User 1 and turn the dial to change the “gear ratio” when jogging between 1 and 20. In other words, it determines how quickly the transport moves in response to turning the jog wheel. The lower the Gear number, the slower the transport will go; the higher the Gear number, the faster the transport will go. The default Gear setting is 13.

– **Rescale Jogger**: Press User 2 to change the gear ratio based on the current zoom level so that three revolutions a second of the jog wheel reaches normal play speed.

– **Follow Zoom**: Press User 3 to toggle Follow Zoom on or off. When on, the gear ratio of the jog wheel is affected by the Zoom setting.

– **Jog DIM**: Press User 4 to toggles Jog Dim on and off. When on, it causes the monitoring level to automatically dim during Loop Jog to the user-defined value set in the Monitor mode Dim level.

– **Loop Jog**: Press User 5 to toggles Loop Jog on and off. When Loop Jog is on, the transport plays a small length of audio (between 5ms and 2000ms), repeatedly, at play speed. The loop moves as you jog the transport forward or backward. This is a great tool for editing, because it maintains the correct pitch of the audio, allowing you to hear clicks, pops, sibilants in the middle of words, and so on. Some of the other soft keys in this menu control additional Loop Jog parameters.

– **Width:80**: Press User 6 and turn the dial to sets the width for the Loop Jog in milliseconds between 5ms and 2000ms. This is the amount of audio that is repeated in each loop. The default width is 80ms.

– **Talkback**: This Setup layout offers three options to customize the Desktop Console Talkback functionality.

– **Smart Talk/Push-2 Talk**: Press User 1 to toggle between the default unlatched Smart Talk option and the latched Push-2-Talk option. Smart Talk allows the user to either latch the Talk button for extended hands-free talkback, or Push-2-Talk with a momentary press on the Talk button. Latching this key toggles on the Push-2-Talk mode, which limits talkback to the momentary-press Push-2-Talk method similar to using a 2-way radio.

– **GPI>None/Talk/DIM**: Press User 2 to toggle the Monitoring Controls for the general purpose input (GPI) between None, Talk plus DIM, or DIM only.

– **None/Talk/Armed/Record>GPO**: Press User 3 to determine when the general purpose output (GPO) sends a signal during a session. This Quick Menu button toggles between Talk, None, Armed and Record.

**NOTE**: At the time of this documentation, the blank User Set and subsequent blank button options are not yet functional. Stay tuned for future updates.

### Fairlight Desktop Console Configurations

There are three ways that you can configure the Fairlight Desktop Console with your DaVinci Resolve workstation:

As a standalone mixing controller, simply connect the Fairlight Desktop Console to your DaVinci Resolve computer for professional control of the Edit page Mixer as well as the Fairlight page recording, mixing, and automation workflows.
Add a second monitor via HDMI for enhanced visual feedback of the mixing parameters while you work with the console. This configuration gives you realtime graphical updates on the screen, similar to the Channel Control LCD in the full-sized modular Fairlight consoles.
Connect to a Desktop Fairlight Audio Editor and DaVinci Resolve computer for control of nearly every function on the Fairlight Page interface. This expanded desktop configuration is similar to a 2-bay Fairlight modular console at about half the price.

Performing Firmware Updates

Some DaVinci Resolve updates, such as 17.2.1, require firmware updates to implement the improvements to the Fairlight Desktop Console. To use the DaVinci Control Panels Setup utility for the first time, you need to perform a custom install of the latest version of DaVinci Resolve and in the custom settings, check the option to install the DaVinci Control Panels utility. Once installed, you can select any DaVinci Resolve panel connected to your system and perform network setup and firmware updates.

**Updating firmware on a Fairlight Desktop Console:**

1. Quit DaVinci Resolve, if necessary.
2. Open the DaVinci Control Panels Setup utility.
In the DaVinci Control Panels Setup Utility, select the Fairlight Desktop Console.

**NOTE:** If you are working with the Fairlight Desktop Console or Desktop Fairlight Audio Editor, there will only be one panel from which to choose.

4 Click the circled icon below the panel name.

5 If there is a firmware update available, you will see an update dialog.

6 Click Update to install the updated firmware on that panel.

7 Once the update is complete, click Done.

8 Close the DaVinci Control Panels Setup.

9 Open DaVinci Resolve.
The Fairlight Audio Editor lets you quickly navigate large projects and precisely edit audio much faster than using a regular mouse and keyboard. Using the Audio Editor to control the Fairlight page provides fingertip access to nearly every Audio tool, function and workflow you’ll need to create incredible soundtracks within DaVinci Resolve. In addition to editing audio tracks, clips and waveforms, the Fairlight Audio Editor can also be used to set up, record, arrange, sweeten, mix and master your projects.

Whether you are using a Fairlight Desktop Audio Editor or a Fairlight Audio Editor panel in a Fairlight console, the tools and functionality of both models are the same. This chapter covers details about the Fairlight Audio Editor’s powerful design features, controls, edit modes, multi-functional keys and how they work with DaVinci Resolve.

Please refer to the previous Fairlight chapters for details on using the Fairlight page.

Contents

About the Fairlight Audio Editor 3408
Audio Editor Functional Overview 3409
Types of Controls 3410
Audio Editing Modes 3411
Transport, Modifier, and Escape Keys 3412
Latch, Long, and Momentary Key Press Functions 3413
Track Selection Keys 3415
Moving Track Selection with the Jog Wheel 3418
Switching Pages 3418
About the Fairlight Audio Editor

Fairlight Audio Editor panels are designed to meet modern audio post production workflow demands while providing ease of use so that audio professionals can quickly and precisely execute both simple and demanding audio editing tasks. These dedicated Fairlight editing control panels are available in either desktop or console models. The difference is that the desktop model is a stand-alone panel designed for audio editors working at individual computer workstations, while the console model has an extended frame that fits into the Fairlight console chassis and is then connected to all of the console’s modular panels. Both models are essentially the same panel, aside from how they are mounted, so if necessary, you can use a Console Audio Editor on your desktop, and likewise a Desktop Audio Editor can be connected to a Fairlight console that does not already include an Audio Editor component.
With its modest size that fits any desk or workspace, the Fairlight Audio Editor keeps every function within reach for simple navigation as well as performing complex two-handed operations. Plus, the user-friendly design is easy to learn and master with a variety of highly visual, intuitive controls including: touch-sensitive control knobs, macro buttons, built-in Editor screen with soft buttons, number keypad, jog wheel, and a full QWERTY keyboard with multi-functional picture keys.

The Fairlight Audio Editor is organized into six sections, each with a specialized set of controls that work in tandem with the Fairlight page interface to perform high-speed, audio tasks within your DaVinci Resolve project.

Audio Editor Sections in Clockwise Order

On the upper-right of the Editor, you’ll find the Monitor section complete with knobs and buttons to control the level of the speakers in both the control room and studio as well as talkback. Below the Monitor section is a numeric keypad for entering timecode and go-to operations. The lower-right of the Editor includes an electronic jog wheel for full shuttle and jog transport control, along with a handy set of fixed transport buttons, Undo, Redo, Zoom and Shuttle playback and Jog response keys. To the left of the jog wheel and control buttons is the full-sized QWERTY keyboard with multi-functional self-labeling picture keys for nearly every audio action, tool, function, or workflow. Located directly above the keyboard is the built-in Editor screen which offers an interactive graphical display of the signal processing parameters for the selected track or master bus. The Editor screen is surrounded by sixteen soft menu buttons and three touch-sensitive knobs on the left- and right-side of the screen for dial parameter control. Finally, along the top there is a row of 15 fixed buttons that include ESC and 14 user-defined Macro Quick keys.

Audio Editor Functional Overview

At face value, the control knobs, jog wheel, buttons, and keys function as expected, based on the current Audio Editor mode. However, the way you press keys and the addition of modifiers can place even more options at your fingertips, without the need for changing editing modes or mousing through menus on the Fairlight page interface. So, before diving into a detailed rundown of the Fairlight Audio Editor, it’s important to understand some of the multifaceted controls and functional nuances designed to minimize your keystrokes while maximizing your speed and productivity.

This section offers a quick overview of the types of controls, editing modes, transport and modifier keys, key-press options, as well as pointing out the designated Track Selection, Menu and DaVinci Resolve interface page keys.
Types of Controls

A good starting point for getting to know the Fairlight Audio Editor is to acquaint yourself with the different types of physical controls.

- **Jog Wheel**: To quickly navigate, zoom, change clip levels and more, this fully integrated, highly responsive electronic dial offers smooth free rotation or clutch action control.

- **Knobs**: When you want to make fast changes to specific parameters, these versatile knobs give you precision rotary control, as well as touch-sensitive input for enabling automation or resetting levels. The Audio Editor includes two fixed-parameter knobs with the monitoring controls and six multifunctional soft menu knobs around the Editor screen which are assigned to parameters based on the current Editor mode and active toolset. Holding the Shift modifier key changes the gearing for finer controls, while holding the Control modifier key while touching one of these knobs will reset the knob’s current parameter to its default value. For example, if the Audio Editor is in Monitor mode, holding the Control key while touching the knob controlling Fixed Level resets the parameter to 0 dB.

- **Fixed Keys**: These keys are located along the top and right side of the Audio Editor. Unlike the multi-functional soft menu buttons and picture keys, the fixed keys have printed labels based on their designated purpose. Among the fixed keys you’ll find the Macro quick keys, Monitoring Control keys, Numeric keypad keys, Jog and Transport Control keys, along with Undo, Redo, Record, Zoom, and Enter. Fixed keys are white with black labels, with the exception of the two red Mute keys in the Monitoring controls.

- **Soft Menu Buttons**: Above and below the Editor screen are two rows of eight soft menu buttons for a total of 16 buttons used to either toggle or show alternate pages of controls in the Editor screen based on the current Editor mode. The upper row of soft menu buttons are always toggles, such as the EQ In or EQ Bypass, when the EQ parameters are active, or a Boom toggle that alternates between: Boom Post, Boom Pre and Boom Only when the Pan parameters are active. The eighth button in the upper row toggles between page 1 and page 2 of functionality assigned to the first seven soft menu buttons. The lower soft menu buttons control parameters assigned to the six knobs, with the middle six lower soft menu buttons controlling which primary set of parameters are assigned to the knobs, like Track Level, Left/Right and Front/Back controls when the Pan parameters are active in the Editor screen. The left and right lower soft menu buttons reveal alternative controls assigned knobs, such as the alternate Pan parameters, Rotate, Tilt and Up/Down, assigned to the right three knobs.
– **Picture Keys:** These self-labeling picture keys change their appearance and function dynamically, based on whatever the user is doing at that time and offer control for nearly every tool, panel, action, and task on the DaVinci Resolve Fairlight page. Additionally, the picture keys default to a standard QWERTY keyboard whenever user text input is needed (this setting is governed by the QWERTY: Auto/Off setting in the Setup mode), or when the DaVinci Resolve software displays a page other than Fairlight.

**Audio Editing Modes**

To accommodate the numerous audio post production toolsets and workflows, the Fairlight Audio Editor includes six primary Editor modes that change the picture keyboard layout and Editor functions based on the operational task at hand. These six “mega” Editor modes are conveniently named after their toolsets as follows:

– **Setup:** This mode provides quick access to non-editing operational windows, view options, and functions such as opening the Bus Format and Bus Assign windows, toggling on and off audio track layers, and saving a project.

– **Record:** As you probably guessed, this mode presents the precision tools you’ll need to perform manual, punch-in and ADR recording.

– **Monitor:** Use this mode to quickly change your fixed monitoring levels, isolate speakers, buses or mains, switch to alternate speaker sets, toggle phase, and other control room playback monitoring functions.

– **Macros:** This mode presents 30 programmable Macro keys where you can record sequences of keystrokes for repetitive tasks to each Macro key.

– **Mix:** Transforms the Fairlight Audio Editor into a robust mixing tool with full control of Fairlight page Mixer functions like track EQ, Dynamics and Pan settings, copy and paste settings between tracks, as well as utilizing the full automation recording and editing toolset.

– **Edit:** This is where the Fairlight Audio Editor got its name and reputation for unparalleled speed and accuracy for every aspect of audio post editing from auditioning and syncing sound effects to checkerboard editing dialogue tracks on the fly.
Transport, Modifier, and Escape Keys

While working with the Fairlight Audio Editor, you will always have access to the standard Transport, Modifier, and Escape keys, even while using the QWERTY keyboard for entering data. The Transport and Modifier keys are located at the bottom of the keyboard, and the Escape (ESC) key is at the top row of the editor with the Macro Quick keys.

You’ll use the Transport keys: Rewind, Fast Forward, Play, Stop, and Record for navigation, playback and recording along with the jog wheel and its adjacent fixed transport keys.

The standard modifier keys: Shift, Control, Command and Alt, work in conjunction with the QWERTY keys for default and user-defined keyboard shortcuts along with your mouse while operating other pages of DaVinci Resolve. When you are using the Fairlight Audio Editor to control the Fairlight page, the Control key (CTRL) is an essential modifier for revealing secondary functions on the self-labeling picture keys. For example, when you press the Control modifier key, the Rewind and Fast Forward transport keys become Project Start and Project End keys. Additionally, the Shift modifier key can be used in conjunction with the knobs for refined incremental parameter control.

Another important key that you’ll find on a standard computer keyboard as well as the Audio Editor is the Escape key. This key lives up to its name as an all-purpose “escape” that can be used at any time to exit an operation, action, data entry or menu without saving the changes since the last save. The Escape key works as an operational override for a variety of functions including: GoTo functions, naming clips, setting values in dialog boxes, opening, closing and saving files, and any time a Cancel button is shown in a dialog on the computer screen.

As you learn your way around the Editor, you’ll soon appreciate the convenient locations of the Transport, Modifier and Escape keys in the lower-right, lower-left, and upper-left positions respectively.
NOTE: If your Audio Editor is connected to a Fairlight console, the Control key on the Editor works in tandem with the Control buttons on the Fairlight Console Channel Control panel and Channel Fader panels to access secondary functions, parameters and controls. Also, there is an independent ALT key below the built-in Editor screen that is used to toggle between additional parameters on the left- and right-side of the screen. This ALT key is dedicated to the Editor Screen controls.

Latch, Long, and Momentary Key Press Functions

Unlike standard keyboard and numeric keypad keys, which deliver the same result whether the keys are typed or held down, many Fairlight Audio Editor keys have multiple operational states which elicit different results depending on how you press or hold the key. The three types of key presses are:

- **Latch**: Quickly pressing and releasing a key, just as you would with normal typing, is referred to as latching and results in toggling on or off that key’s function.

- **Long-press**: A long-press is performed by simply pressing a key longer than you would if you were simply typing it. When performing a long-press, you only need to press the key long enough to see the desired result, such as opening or closing a window on the Fairlight page GUI. Long-presses are only slightly longer than typing, about 300 milliseconds, so they don’t slow you down, they just offer more functions within a fixed number of keys. These long-presses can be real time savers, and in many cases replace the need to reach for the mouse to click the Fairlight page interface.

- **Momentary hold**: A momentary hold involves pressing and holding a key with one hand to reveal additional keys and functions that can be quickly latched with the other hand.

NOTE: From this point forward, descriptions such as type or press indicate a latched operation, long-press means to press longer than usual until you see the desired result, and instructions to hold and release refer to momentary operations.

Examples of Long-Press and Momentary Key Press Actions

Here are three examples of these types of button presses in action.
Using a long-press to open or close GUI windows:

There are five signal processing picture keys, including Pan, EQ, Dynamics, Aux, and Plug-in. These correspond with the graphical display in the built-in Editor screen as well as the Fairlight Mixer on the computer screen. If you latch one of these keys, such as EQ, the Editor screen displays EQ parameters for the selected track. In turn, these parameters can be controlled by the adjacent soft buttons and knobs without opening the GUI controls on the computer screen. However, long-pressing the EQ key both selects these controls and opens the EQ window on the computer screen. The EQ window will stay open until you long-press the EQ key again to close it. This works the same as double-clicking the EQ control on the Fairlight Mixer UI, and then clicking the Close button on the EQ window to close it.

NOTE: Once you open a signal processing window using a long-press, the GUI window will automatically change to follow the current latched signal processing displayed in the Editor Screen and vice versa. So if you open the EQ window with a long-press, then latch the Pan key, the GUI window on the computer screen will change to the Pan window and the Editor screen will display controls for the Pan signal processing. If you want to see more than one signal processing window at a time on the computer screen, you’ll need to double-click them independently with the mouse.
Using a momentary key press to briefly enter a different Editor mode:

Each Editor mode includes a picture key toolset unique to that mode, however, audio work is a fluid process that sometimes requires users to jump back and forth quickly between toolsets while they work. Rather than reach for the mouse to access a menu, panel, setting, or tool via the Fairlight page interface, you can momentarily jump into another mode to access the tool you need, then jump back and continue your current task.

For example, you could be monitoring playback levels and recording automation data in Mix mode when you decide to reset the Loudness meters to check the section that is coming up. The Loudness Reset controls are accessed via the Monitor mode Editor Screen controls. To get to them, momentarily hold the Monitor mode button with your left hand to reveal the Monitor mode picture keys and Editor screen controls. With your right hand, quickly latch the Loudness soft key below the Editor screen to display the Loudness settings, then press the Reset Loudness toggle key above the Editor screen to reset the Loudness meters. Release the Monitor mode button to return to Mix mode without interruption in playback or automation recording. This type of momentary operation is one of the secrets to harnessing the Fairlight Audio Editor’s speed and power because at any time, in any workflow, you can momentarily jump to a different mode to access a key to do something else and return to the previous task without stopping. In fact, it is common to momentarily jump into the Setup mode toolset while you work because that is where you’ll find keys to quickly toggle on and off track layers, show or hide the Video Scroller, set the playhead (CTI) to fixed or moving, as well as save your project and modify the Audio Editor’s playback controls.

Another advantage of momentary key presses is that they don’t change the latched state of the key you are holding. Working with momentary key presses requires a bit of skill to master, but it can greatly increase your overall speed and efficiency.

Using a momentary key press to reveal related menu option keys:

Latching the Play Jog key starts playback and unlatching the same key engages the jog wheel. Momentarily holding the Play Jog key reveals six related menu option keys in the picture keys along the left side of the jog wheel without changing the current latched or unlatched state of the Play Jog key. While momentarily holding the Play Jog key, you can quickly latch any of the menu option keys. When you release the Play Jog key, the menu option keys are no longer visible. This maneuver can easily be done with the right hand while controlling the jog wheel.

Track Selection Keys

Quickly identifying and selecting tracks and buses is a vital part of recording, editing, and mixing workflows. Therefore, the Fairlight Audio Editor includes a dedicated row of picture keys, at the top of the keyboard, for selecting either tracks or master buses.
Track Selection keys utilize the Fairlight Audio Editor’s unique self-labeling picture key technology to display each track’s user-defined name and color just as it appears in the Fairlight page Timeline. Additionally, the Track Selection keys change appearance to reflect their current state so that you can quickly identify which tracks are selected and which track is actively displayed in the built-in Editor screen. When multiple tracks are selected, the most-recently selected track is always the track actively displayed on the Editor screen. Track Selection keys also reflect each track’s status with a colored icon that indicates if the track has been muted (M), soloed (S), or armed for recording (R).

**TIP:** Holding the CTRL key down reveals alternate commands, including Mute Clear and Solo Clear (to clear either Mute or Solo states from all tracks). Holding the CTRL key and pressing Mute Clear or Solo Clear a second time acts as a specialized undo/redo toggle to restore all tracks to their previous Mute or Solo state prior to being cleared. This is incredibly useful during mixing so that you can focus on a set of soloed tracks, un-solo them all simultaneously to hear them with the mix, then quickly return them to their soloed state.

**Track Selection key states and appearance changes include:**

- **Unlatched:** The track is deselected, with the track’s color showing as a bar above the track’s name.
- **Latched:** The track is selected, with the track’s color expanding over two thirds of the button.
- **Active:** The active track can easily be identified by a white bar on the lower third of the key and the track’s color in the upper two thirds. Additionally, the active track’s name, track number, track color and signal processing parameters are displayed on the Editor screen.

ADA VO wFX and ROOM tracks are selected, Room track is active, PFX muted, MEDLAB 1 and MEDLAB 2 tracks are soloed, and the DRONE track is deselected.

Master buses showing in the Track Selection keys with Main 1 active and the main named 5.1 muted.
**NOTE:** Pressing a Track Selection key is the same as clicking a track header or channel strip in the Fairlight page Mixer with your mouse.

**Pressing a Track Selection key does all of the following simultaneously:**
- Latches or unlatches that Track Selection key with visual feedback accordingly.
- Selects or deselects that track in the Fairlight page Timeline and Mixer.
- Displays that track’s signal processing in the built-in Editor screen.
- Tallies on or off that track’s Channel Select button and calls up that channel’s parameters on the Fairlight Console Channel Control panel, if you are working on a Fairlight console.

The dedicated Track Selection keys are located in the top row of the picture keyboard, where the number keys would be on a standard keyboard. Here you’ll find 12 track selection keys as well as All Tracks, Page Up (↑), and Page Down (↓) keys.

You can select multiple tracks by pressing additional Track Selection keys. However, there can only be one active track at a time and it’s always the last Track Selection key pressed. Like most Fairlight Audio Editor keys, the Track Selection keys include some unique selection nuances to improve your efficiency without the need for a mouse.

**Track Selection keys and key-press options:**
- **Track Selection keys:** There is one Track Selection key for each track in the Fairlight page Timeline. From left to right the first 12 keys are Track Selection keys that follow the order of the tracks in the Timeline from top to bottom. Press once to select or deselect a track. Select as many tracks as needed, one track at a time, by simply latching the corresponding Track Selection keys. Double-press any Track Selection key to deselect all other tracks and actively select the current track. Hold a Track Selection key, then double-press another Track Selection key to select both tracks as well as all contiguous tracks between them. In this case, the key that was double-pressed will become the active track.
- **All Tracks:** Press this key to quickly select or deselect all tracks in the Timeline. Long-press the All Tracks key to change the entire picture keyboard to Track Selection keys for up to 48 tracks from left to right top to bottom. When All Tracks is latched, you’ll also have the option to continue to show tracks, or display master buses such as the Mains, Submix and Aux buses, and VCA groups. Below the All Tracks key, on the far right side of the picture keyboard, you’ll see the Tracks and Masters keys. Here you can choose which type of feed is displayed in the top row of the picture keyboard. Tracks are all of the Timeline tracks, and Masters are the buses for mixing and output. Long-press the key again to return to the default picture keyboard with one row of 12 Track Selection keys at the top.
- **Page Up (↑):** Pages up to display the previous 12 tracks in the top row of Track Selection keys, or the previous 48 tracks when the picture keyboard is set to display 48 Track Selection keys. Holding Ctrl- changes the Page Up key to a Bank button for loading a user-defined bank of tracks.
- **Page Down (↓):** Pages down to display the next 12 tracks in the top row of Track Selection keys, or the next 48 tracks when the picture keyboard is set to display 48 Track Selection keys. Holding Ctrl- changes the Page Down key to a Bank button for loading a user-defined bank of tracks.

**NOTE:** Hiding track visibility in the Timeline, using the Index, or using the Hide Track key on the Audio Editor hides a track from the Timeline and Mixer, but does not change the corresponding track’s state, output or Track Selection key. Additionally, in DaVinci Resolve 16 and higher you can show all master buses including Mains, Subs and Aux buses as tracks in the Timeline as long as the Automation toolset is showing and the buses are marked visible in the Tracks Index.

Chapter 182 Using the Fairlight Audio Editor
Moving Track Selection with the Jog Wheel

Whether you select a single track or multiple tracks, you can quickly move the entire selection up or down with the use of the Move Selected picture key and the jog wheel. The Move Selected key is available in both the Record and Edit mode toolsets. This is incredibly useful when working with high track counts so that you can select a track or group of tracks much higher or lower in the Timeline without the need to grab your mouse to scroll. Simply hold the Move Select key while you turn the jog wheel clockwise to scroll the selection down to lower tracks, or counter-clockwise to scroll up to higher tracks. Keep in mind this only moves the selection and does not move the tracks or the contents of the tracks.

Switching Pages

Although the Fairlight Audio Editor is designed to work exclusively with the Fairlight page in DaVinci Resolve, there may be times when you need to switch to a different page in DaVinci Resolve, such as importing and syncing audio files in the Media page, or rendering a finished mix in the Deliver page. The Menu key, located next to the modifier keys in the lower-left corner of the picture keyboard, lets you quickly access the QWERTY keyboard, or any of the other pages in DaVinci Resolve. A momentary-press on the Menu key reveals keys for each of the DaVinci Resolve pages in the order that they are listed at the bottom of the software interface: Media, Cut, Edit, Fusion, Color, Fairlight, and Deliver. There is also a QWERTY key to temporarily change the picture keys to a QWERTY keyboard.
NOTE: The Fairlight Audio Editor is designed to work with the Fairlight page. If you switch to a different page in DaVinci Resolve, you’ll need to use your computer keyboard and mouse for any operations in the user interface. While other pages are open, the Fairlight Audio Editor shows a QWERTY keyboard that you can use to trigger keyboard shortcuts while working on those pages, just like an ordinary computer keyboard. Once you return to the Fairlight page, the Audio Editor will resume working.

Fairlight Audio Editor

Now that you are familiar with the general layout, types of controls, Editor modes and key-press options in the Fairlight Audio Editor, it’s time to dive deeper into the different areas of operation and how everything works together. Keep in mind that the Fairlight Audio Editor is essentially an over-sized mouse designed specifically to control the DaVinci Resolve Fairlight page. Therefore, the better you understand the Fairlight page, the more proficient you’ll be with your Audio Editor panel.

Please refer to the previous Fairlight chapters for detailed information on the software interface, tools, functions, and audio workflows. However, with the increased functionality and physical controls available on the Fairlight Audio Editor, there are some functions and workflow enhancements that are only available via the Editor panel. This section will give an overview of the entire Fairlight Audio Editor and focus more in-depth on unique features and functions that go beyond the standard keyboard and mouse options in the Fairlight page.

Monitor Section

The Monitor section in the upper-right corner of the Fairlight Audio Editor panel is where you control playback levels for the Control Room and Studio speakers. Control Room monitor levels can be changed at any time using the Control Room knob. Adjusting these controls also adjusts the corresponding onscreen monitoring controls in DaVinci Resolve.

Control Room monitoring controls include:

- **Control Room knob**: this can be used to quickly dial the level of the speakers selected in the control room. You can select alternate control room speaker sets in the Monitor mode toolset.

- **DIM**: This button reduces the Control Room monitor volume by a user-defined amount. Press to toggle Dim on or off. You can set the Dim level on the Editor screen in Monitor mode.

- **MUTE**: Use this button to mute or unmute the Control Room monitors.

The Studio controls control the Studio monitoring circuit of a Fairlight Accelerator card installed on your workstation.

Studio monitoring controls include:

- **Studio knob**: Use this to dial the level of the speakers in the Studio.

- **Talk**: Latch this button to toggle on or off a talkback microphone. When latched, the talkback mic remains live. Momentary-press the talk button to use talkback without latching, in this case, the talkback mic will remain live only during the momentary-press and shut off when you release. Press Control with the Talk button to open or close the Talkback Settings window on the computer screen. Engaging Talk also dims the Control Room circuit. You can modify the talkback functionality and general purpose input and output (GPI/GPO) via the Talk Setup menu option keys in the Setup mode picture keys.

- **MUTE**: Use this button to mute the Studio monitors.
User-defined Fixed Control Room and Dim levels

Sometimes the monitoring environment must be set to a standard level and not changed. This is called Fixed Level monitoring. For example, if your control room has been calibrated with a sound pressure level (SPL) meter, you will probably want to set a Fixed monitoring level. When fixed, the Control Room knob has no affect on the monitoring levels. You'll find controls for Fixed Level monitoring on the built-in Editor screen in Monitor mode. Here you can also toggle on and off Fixed level monitoring and adjust the Dim level. When Fixed Level monitoring is toggled on, the listening level meter in the upper-right of the Timeline GUI turns from green to blue.

To set and reset Fixed and Dim Control Room monitor levels:

1. Latch or momentary-press the Monitor mode key to enter the Monitor toolset and show the Dim Level and Fixed Level controls on the left side of the Editor screen.

2. Use the top control knob to adjust the adjacent Dim level amount onscreen. As you turn the knob left or right, the Dim level GUI changes accordingly.

3. Use the middle knob to adjust the adjacent Fixed Level control using the GUI display in the Editor as a guide.

4. To toggle Fixed Level monitoring on or off, press the soft button directly above the Fixed Level On/Off button on the Editor screen. This can be done anytime during playback, recording, or mixing sessions by simply using a momentary-press on the Monitor mode key then toggling on or off the Fixed Level On/Off soft button.

5. Hold the Control key while touching a touch-sensitive knob to reset it to the default value. In this case, the default Dim level is -15dB and the default Fixed Level is 0.0dB.

6. When finished, release the Monitor key If you were performing a momentary-press. Otherwise, simply latch a different Editor mode key to exit Monitor mode.
TIP: Setting monitor levels is an example of how different areas of the Fairlight Audio Editor work together to quickly achieve a goal. To further define an example, a user could be in the middle of a session and decide to change the Dim level. Without interrupting the current task, the user could momentarily hold the Monitor mode key with one hand and with the other hand, quickly adjust the Dim Level. When finished, the user only needs to release the Monitor key to resume whatever they were working on. Latching the Dim button on the Monitor controls will now reduce the Control Room monitors to the newly defined Dim level.

**Numeric Keypad**

For the most part, the numeric keypad on the Fairlight Audio Editor is self explanatory and functions exactly the same as the numeric keypad on an extended keyboard for entering timecode and number values. There are, however a few specialized keys, such as Colon (:), Clear, and GoTo, that can be used to expedite timecode entry, set locators, and quickly move the playhead or clip to a specific time. Additionally, there are some user-definable operations, such as Review, where you can combine a momentary hold on the Review key plus a Number Key (1 to 9) to set the number of seconds you’d like the playhead to jump back for the Review operation. The timecode is displayed in the Timecode field in the upper-left corner of the Timeline on the computer display, so you can always see the new timecode values as you type.
Numeric Keypad Keys:

- **Number Keys 0 to 9**: Used for entering number values and timecode entry. Timecode entry requires latching the GoTo Key first.

- **GoTo**: When latched, the numeric keypad is in GoTo entry mode and numbers you enter determine where the playhead will move when you unlatch the GoTo key. Numeric entry can include numbers, timecode, or timecode increments. Positive numbers move forward in the Timeline and negative numbers move back.

- Use a momentary press on the GoTo key to jump to one of the three user-definable locator positions in the Timeline.

- Additionally, when the GoTo key is latched, the standard Play and Stop transport keys become GoTo Play and GoTo Stop keys. This can save a keystroke for the operator so they can type in timecode and immediately go to that location and play or stop without first unlatching the GoTo key.

- **Plus (+)**: Used in typing or to increment numbers. Typing a Plus before entering a numeric timecode value moves the playhead forward by that value. For example, latching the GoTo key, then typing +0500 and unlatching the GoTo key moves the playhead forward five seconds. When typing values with Plus or Minus keys, the values are entered as timecode from right to left. In this example, +0500 = move playhead 05:00 later.
– **Minus (-)**: This key is used in typing or to increment numbers. Typing a Minus before entering a number value moves the playhead forward by that value. For example, latching the GoTo key, then typing -0500 and unlatching the GoTo key moves the playhead back five seconds earlier in the Timeline. When typing values with Plus or Minus keys, the values are entered as timecode from right to left. In this example, -0500 = move playhead 05:00 earlier.

– **Clear**: Clears the current number or timecode entry while in GoTo entry mode. The Clear key can also be used to clear user-defined number values, such as locators.

– **Colon (:)**: This key can be used to separate Hours:Minutes:Seconds:Frames in timecode entry, or as a numeric shortcut key that represents a timecode position and replaces 00 when entering timecode. When you type two numbers, a colon is automatically added before the third number. Likewise, typing two numbers followed by a colon also places the colon directly after the two numbers you just typed. This follows standard timecode entry rules for typing in timecode numbers. In this case, to substitute 00 with the colon key, you need to type a second colon. Subsequent typed colons in the same timecode entry event will automatically substituted 00.

The number of colons typed before or after a number indicates the timecode position of the number in the GoTo command. For example, latching GoTo then typing 02:::02 (zero, two, colon, colon, colon, zero, two), then unlatching GoTo moves the playhead to 02:00:00:02. Additionally, the Colon key is a real time saver for navigating to specific areas of the Timeline without the need to type the entire number. The position of the Colon in the numeric shorthand value typed determines if the numbers entered as timecode start from the right as frames, or if you keep the current timecode and move to a designated hour from the left.

For example, if the playhead is currently positioned at 01:00:00:00 and you latch GoTo, then type :20 (colon, two, zero) when you unlatch GoTo, the playhead will move to 01:00:00:20. However, if you then latch GoTo and type 02: (zero, two, colon), then unlatch GoTo, the timecode entry is incremental from right to left, so the result is 01:00:02:00.

**TIP**: Timecode entry appears in the upper-left corner of the Fairlight Timeline on the computer screen. If you wish to change the timecode to display subframes, you can right-click the timecode display and choose the display setting you wish from the drop-down menu. You can also open a floating Timecode window that displays the playhead position (CTI) from the Workspace menu.

**Numeric Keypad Locators**

The Fairlight Audio Editor includes three user-defined locators that are used to quickly move the playhead to a stored timecode location. These non-permanent locators are designed to use freely in editing and mixing, but are not saved with the project. A momentary-press on the GoTo key is required to use, set, or clear the locators, which are assigned to the 1, 2 and 3 keys on the numeric keypad.

Navigating with locators is a fast and easy way to jump to key positions in the Timeline. Setting a locator based on the current timecode position is often the first and last operation when recording macros so that the macro can start and end at the current timecode position. At this time, locators are only available in the Fairlight Audio Editor.

**To set one of the three user-defined locators:**

1. Move the playhead to the timecode position that you wish to save as a locator position. In this example you will assign the current playhead position to the first locator on the 1 key.

2. Momentary-press the GoTo key. This illuminates the 1, 2, and 3 keys on the numeric keypad. Continue to hold the GoTo key.

3. Momentary-press the 1 key until it tallies on to show that it has been set.
4 Release both the GoTo and 1 keys. You can follow the same steps to set the second and third locators that are assigned to the number 2 and 3 keys. Locators can be set to new timecode positions anytime while you work and do not have to be cleared before setting a new location.

**To use a locator for navigation:**

1. Momentary-press the GoTo key. The number keys, 1, 2, and 3 illuminate. In this example, you will go to locator number 2.
2. Continue to press the GoTo key. Quickly press and release the 2 key.
3. Release the GoTo key. The playhead jumps to the second locator timecode position.

**NOTE:** You need to first set a locator before it can be used. Locators are not saved with the project.

**To clear all locators:**

1. Momentary-press the GoTo and Clear keys. The number keys, 1, 2, and 3 illuminate, but continue pressing the GoTo and Clear keys.
2. Long press each of the 1, 2, and 3 number keys to tally them on.
3. Release the GoTo and Clear keys. The locators are now clear and will not affect the playhead position until they are set to new timecode locations.

**Jog Wheel with Fixed Keys and Soft Menu Picture Keys**

The jog wheel and surrounding Fixed keys offer a complete set of transport commands, designed to let you keep your hand in one position while editing. Here you can not only navigate the Timeline from end to end or anywhere in between in seconds, but also go from seeing all tracks to a focused zoom on a single clip at the sample level faster than you could reach over and pick up a traditional mouse. The combination of the jog wheel and Fixed keys offer standard and advanced playback and navigation options that can be defined in Setup mode and with the adjacent picture keys. The soft menu picture keys to the left of the jog wheel display menu options related to Fixed key and Shuttle functions. Since this section of the Fairlight Audio Editor includes such an extensive set of features and functionality, let’s start with the jog wheel as a means of navigation and playback, then move on to the Play menu picture keys, Fixed keys, and subsequent additional soft menu picture keys.
Shuttle/Jog Wheel

The jog wheel is the most versatile control on the Fairlight Audio Editor, and is designed for ease-of-use with all of the associated keys within reach. As a means of navigation and playback, the wheel has two modes of operation, shuttle and jog, that are initiated by the respective Shuttle Position and Play Jog keys above the wheel.

In Shuttle mode, turning the wheel forward (clockwise) or back (counter-clockwise) starts playback in fast forward or rewind at variable speeds based on the amount the wheel is turned. Releasing the wheel while shuttling forward or back will continue constant playback at the current speed until the playhead reaches the beginning or end of the project.

In Jog mode, the playhead movement is contingent on the movement of the wheel, so you can freely jog forward or in reverse at variable speeds while turning the wheel and playback stops immediately when the wheel is released. Jog mode is generally used to scrub a specific area to focus on audible cues for editing and trimming, or for subframe loop-jog scrubbing to pinpoint issues and fine-tune edits. Shuttle mode is used to quickly navigate to a specific location or start playback at a variable speed. Additionally, the wheel can be used for common functions such as zooming, quickly scrolling track selection to different tracks, changing clip volume levels or even dialing the shape of clip fades.

**TIP:** Holding CTRL and Play/Jog puts the wheel into Shuttle mode. This maneuver also initiates Free shuttle movement even if the Editor setup controls are set to Fixed Shuttle. Thus, pressing CTRL + Play/Jog is a common audio editor shortcut for Free Shuttle control. Additionally, holding CTRL while turning the jog wheel increases the speed 8X. Releasing CTRL returns the wheel to standard jog speed.

Soft Menu Picture Keys

The six picture keys to the left of the jog wheel display soft menu options when you momentarily press the Play/Jog, Rewind, Fast Forward, and Zoom keys. The default soft menu keys that are always available are the Play Menu and Loop keys. Latching the Play Menu key shows six specialized playback options and likewise a long-press on the Loop key shows the Loop Playback options keys that change the looped playback mode assigned to the Loop key.
Latching the Play Menu key displays special play commands on the adjacent soft menu picture keys:

- **Play Again**: Plays from the same place as the last time, such as the timecode where the transport last entered Play. This could also include Play and Record at the same time. This key is the same as the Play Menu key so when the Play Menu keys are not displayed, you can simply press Play Menu twice for Play Again.

- **Play Range**: This operation plays from the In Point (beginning) to the Out Point (end) of a range in the Timeline.

- **Play Clip**: This plays the clip beneath the playhead on the active selected track. If there is no clip beneath the playhead, the next clip on selected track is played.

- **Play In**: Plays from one second before the In Point of a range in the Timeline.

- **Play Out**: Plays from one second before the Out Point of a range in the Timeline.

- **Exit**: Exits the Play Menu.

A long-press on the Loop key displays the Loop Playback Options menu keys:

- **Loop Range**: Loops playback around the marked range, from In Point to Out Point in the Timeline.

- **Loop Clip**: This operation loops playback around the clip beneath the playhead on the most-recently-selected track. If there is not a clip beneath the playhead on the active track, the next clip in the track is played. If a track is not selected, this key has no affect on playback.

- **Loop +/- 1**: This creates a two second playback loop around the current playhead position that starts one second before the playhead and ends one second after the playhead.

- **Loop +/- 3**: This creates a six second loop around the current playhead position that starts three seconds before the playhead and ends three seconds after.

- **Exit**: Exits the Loop Options menu without changing the current loop playback mode.

(Left) Default soft menu keys with Play Menu key unlatched with Loop key set to Loop Clip, (Center) Play Menu key latched, showing Playback Options keys, (Right) Loop key latched, showing Loop Options menu for assigning Loop Playback mode
Fixed Keys in Clockwise Order Starting in the Upper-left Above the Jog Wheel:

- **Shuttle/Position**: Latch this key to engage the wheel as a shuttle control for navigation and playback. Unlatch or press Stop to stop playback and disengage the shuttle wheel. While Shuttle is active, the Rewind and Fast Forward transport keys light up to indicate which direction the transport is moving. In the Setup mode, Editor Setup keys you can change the shuttle to either Free or Fixed mode.

- **Free Shuttle mode**: When engaged, the shuttle wheel turns freely clockwise or counterclockwise, can change direction instantaneously, and shuttles at variable speeds based on the amount and direction you turn the wheel.

- **Fixed Shuttle mode**: Turning the wheel forward or back starts fast-forward or reverse playback at a fixed speed with built-in stops whenever you change direction.

- **Position mode**: Hold the Shuttle/Position key while turning the wheel to quickly position the playhead (CTI) in the Timeline. In position mode, you can move the playhead from the beginning to the end of the Timeline in a single rotation of the wheel.

**TIP:** When the shuttle is set to Fixed Shuttle mode you can temporarily override the fixed setting with a long-press on the Shuttle/Position key after it is latched.

- **Review**: This key jumps the playhead back a number of seconds, then plays. Press this key repeatedly to make multiple jumps. The default review jump back time is four seconds. You can change this setting to any number of seconds by long-pressing the Review button and pressing any button between one and nine on the numeric keypad.

- **Rewind/Jump Back**: This key can operate as either a Rewind key or Jump Back key. You can toggle between key functions in the Setup mode, Editor Setup option keys.
  - **Rewind key**: The operation works exactly as the Rewind key in the Transport keys section of the keyboard; you can press the Rewind key repeatedly to increase speed.
  - **Jump Back**: Use this key to jump back to the previous target based on user selection in the Jump soft menu picture keys to the left of the shuttle wheel. Press and hold either the Fast Forward or Rewind key to choose jump to targets, including To Clip, To Mark, and To Fade from the soft menu picture keys. Jump Back moves to the previous Clip or Fade based on track selection.

- **Fast Forward/Jump Forward**: This key can operate as either a Fast Forward key or Jump Forward key. You can toggle between key functions in the Setup mode, Editor Setup option keys. Since there is already a dedicated Fast Forward key, as well as a shuttle wheel for engaging variable speed Fast Forward, this key is often set to Jump Forward instead.
  - **Fast Forward**: This operation works exactly as the Fast Forward key in the Transport keys section of the picture keyboard. You can press the Fast Forward key repeatedly to increase speed.
  - **Jump Forward**: You can use this key to Jump forward to the next target based on user selection in the Jump soft menu picture keys to the left of the shuttle wheel. Press and hold the Jump Forward key to choose jump to targets, including Clip, Marker, and Fade. Jump forward to the next Clip and Fade targets are based on track selection. Marker targets can be either Timeline markers or Clip markers.
Momentary-press on Rewind or Fast Forward fixed keys shows jump targets in the soft menu keys: To Clips, To Marks and To Fades; latch the jump targets you wish to use for navigation with the Jump Forward and Jump Back keys.

- **Play/Jog**: Use this key to start playback or engage the jog wheel for manual jog control. By default, the first press of the Play/Jog key engages the jog wheel. The second press latches the key in Play mode and starts playback. If the Play/Jog key is latched, unlatching the key re-engages the jog wheel. Once the key has been latched, it toggles between Play and Jog. To disable the jog wheel, press the Stop key. Press and hold Play/Jog to show the associated soft menu options in the adjacent picture keys on the left side of the jog wheel.


- **Loop Jog**: This key toggles Loop Jog on and off. When Loop Jog is on, the transport plays a small length of audio (between 5ms and 2000ms), repeatedly, at play speed. The loop moves as you jog the transport forward or backward. This is a great tool for editing, because it maintains the correct pitch of the audio, allowing you to hear clicks, pops, sibilants in the middle of words, and so on. Some of the other soft keys in this menu control additional Loop Jog parameters.
– **Rescale Jogger:** Use this key to change the gear ratio based on the current zoom level so that three revolutions a second of the jog wheel reaches normal play speed.

– **Jog DIM:** Toggles Jog Dim on and off. When on, it causes the monitoring level to automatically dim during Loop Jog to the user-defined value set in the Monitor mode Dim level.

– **Gear:** This changes the “gear ratio” when jogging between 1 and 20. In other words, it determines how quickly the transport moves in response to turning the jog wheel. You can change the Gear ratio by pressing the Gear key while turning the jog wheel. The lower the Gear number, the slower the transport will go; the higher the Gear number, the faster the transport will go.

– **Width:** Sets the width for the Loop Jog in milliseconds between 5ms and 2000ms. This is the amount of audio that is repeated in each loop. You can set this amount by holding the Width key and turning the jog wheel.

– **Follow Zoom:** This toggles Follow Zoom on or off. When on, the gear ratio of the jog wheel is affected by the Zoom setting. The default setting for this control is toggled on.

– **Record:**Latch this key along with the Play key in the standard Transport keys to begin recording to the armed track or tracks. Press the Stop key to stop recording. To arm a track for recording, press and hold the Record key, then press the Track Selection key for the track you want to arm. Tracks must be patched to an input before they can be armed for recording.

– **Stop:** As you may have guessed, this key stops playback or recording.

– **Up:** You can use this key to move the track selection up to the previous track in the Timeline.

– **Down:** Use this key to move the track selection down to the next track in the Timeline.

– **Redo:** Reverses the effect of the last Undo. This can be used repeatedly to step forward through the editing history.

– **Undo:** Reverses the effect of the last edit and can be used repeatedly to step back through the editing history. Also returns to the location and track selection of the edit being undone. A list of the actions can be seen in the Edit menu > History. There you can also Open History Window to see a full edit history list.

**NOTE:** Undo and Redo works on all editing actions while in Editing mode. While in Mix mode, you can choose either Undo All or Undo Editor. The default Undo setting for mixing is Undo Editor, which limits Undo to editing functions and disables Undo for mixing and automation in Mix mode. The Undo settings can be changed in the Setup mode. For more information about Undo and Redo operations in DaVinci Resolve, see Chapter 1, “Introduction to DaVinci Resolve.”

– **Zoom:** The Zoom key in combination with the jog wheel and modifier keys offers numerous quick zooming and scaling options while you work.

  – Hold Zoom and turn the jog wheel to change the horizontal scale of the Timeline on the computer screen.

  – Hold Control + Zoom and turn the jog wheel to change the vertical scale of the Timeline, which in turn, changes the height of the tracks and the subsequent number of tracks visible in the Timeline. Horizontal scaling always zooms around the playhead, while vertical zooming focuses on the active selected track.

  – Double-tap Zoom to zoom your entire program to fit within the current visible width of the Timeline.
Press and hold Zoom to show the Zoom menu option keys in the adjacent picture keys. These Zoom menu option keys are a fast way to change vertical scaling while zooming horizontally with the jog wheel for dynamic scaling while you work.

These options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Track</td>
<td>Vertically scales the Timeline tracks to show only the active track.</td>
</tr>
<tr>
<td>2 Tracks</td>
<td>Vertically scales the Timeline to show two tracks, including the active track.</td>
</tr>
<tr>
<td>4 Tracks</td>
<td>Vertically scales the Timeline to show four tracks, including the active track.</td>
</tr>
<tr>
<td>8 Tracks</td>
<td>Vertically scales the Timeline to show eight tracks, including the active track.</td>
</tr>
<tr>
<td>16 Tracks</td>
<td>Vertically scales the Timeline tracks to show sixteen tracks, including the active track.</td>
</tr>
<tr>
<td>All Tracks</td>
<td>Vertically scales the Timeline tracks to show all tracks.</td>
</tr>
</tbody>
</table>

Hold Control + Zoom to show a secondary set of Zoom menu option keys, including the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>32 Tracks</td>
<td>Vertically scales the Timeline to show 32 tracks, including the active track.</td>
</tr>
<tr>
<td>48 Tracks</td>
<td>Vertically scales the Timeline tracks to show 48 tracks, including the active track.</td>
</tr>
<tr>
<td>U1</td>
<td>Scales the Timeline to a user-defined view.</td>
</tr>
<tr>
<td>U2</td>
<td>Scales the Timeline to a user-defined view.</td>
</tr>
<tr>
<td>U3</td>
<td>Scales the Timeline to a user-defined view.</td>
</tr>
<tr>
<td>U4</td>
<td>Scales the Timeline to a user-defined view.</td>
</tr>
</tbody>
</table>

Zoom soft menu picture keys, including 1 Track, 2 Tracks, 4 Tracks, 8 Tracks, 16 Tracks, and All Tracks.
Enter: When using the Fairlight Audio Editor for Cut, Copy, and Paste operations, the Enter key functions as a Paste key. Additionally, the Enter key completes and executes many operations. For example, if you are renaming a track using the QWERTY picture keyboard, pressing Enter after typing the name updates the track name, clears the keyboard, and returns to the previous Editor mode.

**NOTE:** In DaVinci Resolve 16.2 and later, a second Zoom button was added to the left side of the picture keyboard while in Mix and Edit mode, so editors can easily reach it with either the left or right hand while working.

The Review, Shuttle mode, Rewind, and Fast Forward keys can all be customized and used in a variety of ways.

**To change the Review jump back amount, do the following:**

1. Momentary-press the Review key to illuminate the current Review setting in the numeric keypad.
2. Long-press a different number of seconds from 1 to 9 on the numeric keypad until it tallys on to set a new review duration.
3. Release the number and the Review key.
   
   a. **Free Shuttle mode:** When engaged, the shuttle wheel turns freely clockwise or counterclockwise, can change direction instantaneously, and shuttles at variable speeds based on the amount and direction you turn the wheel.
   
   b. **Fixed Shuttle mode:** Turning the wheel forward or back starts fast-forward or reverse playback at a fixed speed with built-in stops whenever you change direction.

**To toggle Shuttle mode between Free Shuttle and Fixed Shuttle, do the following:**

1. Latch or Momentary-press the Setup mode key.
2. Latch the Editor Mode key in the Setup toolset to show the Editor Mode menu option keys.
3. In the Editor Mode menu option keys, latch or unlatch the Shuttle option key to toggle between Shuttle Fixed and Shuttle Free settings.

**To toggle the Rewind and Fast Forward keys to Jump keys or vice versa, do the following:**

1. Latch or Momentary-press the Setup mode key.
2. Latch the Editor Mode key in the Setup toolset to show the Editor Mode menu option keys.
3. In the Editor Mode menu option keys, latch or unlatch the shuttle option keys to toggle between Shuttle Fixed and Shuttle Free settings.
4. If the Fixed Rewind and Fast Forward keys are in Jump mode, you can toggle them to Wind mode by following steps 1 and 2, then unlatch the Mode Jump key to toggle it back to Mode Wind.

**To set a user-defined Zoom view in the Timeline.**

1. Momentary-press the Zoom and CTRL keys.
2. In the soft menu picture keys, long-press one of the user keys (U1, U2, U3, or U4) until the main picture keyboard shows all tracks.
3. In the picture keyboard, latch the track selection keys for all of the tracks you would like to include in the user-defined view.
4. At the bottom of the picture keyboard, momentary-press the Menu key and the Fairlight key to exit the user Zoom setup mode.
5. You can repeat steps 1-3 for each of the four user-defined Zoom view keys.
To use a user-defined Zoom view in the Timeline.

1. Momentary-press the Zoom and CTRL keys.
2. In the soft menu picture keys to the left of the jog wheel, press the user view key (U1, U2, U3, or U4) to choose that view.
3. Release the Zoom and CTRL keys.
4. Latch or unlatch track selection keys to add or remove them from the current zoomed view.

Self-Labeling Picture Keyboard

The picture keyboard offers six different key layouts based on the six Editor modes. It also functions as a QWERTY keyboard for typing and data entry. Each Editor mode includes a specialized toolset of keys, unique to that mode. If you are familiar with the Fairlight page in DaVinci Resolve, the picture key functions are self-explanatory as they are clearly labeled with text and icons. For even easier identification, you can change the appearance of the picture keys to text only in the Editor Setup options on the Setup mode keyboard toolset by toggling the Icon Buttons key to reflect as Text Only.

Since there are hundreds of picture key tools for nearly every function on the Fairlight Page in DaVinci Resolve, this section will focus on the types of picture keys, the different Editor mode toolsets, and keys in each Editor mode that offer tools and options that are only available in the Fairlight Audio Editor.

Types of picture keys:

– **Editor Mode Keys:** These keys determine the current mode of operation in the Fairlight Audio Editor. There can only be one active mode at a time, however, you can momentarily jump into a different mode to choose a setting, tool, or task, then jump back to the current mode. These modes include: Setup, Record, Monitor, Macro, Mix, and Edit.

– **Menu and Menu Option Keys:** Pressing or latching a Menu Key reveals a group of Menu Option keys adjacent to the latched Menu key. In most cases the Menu Option keys remain visible until you unlatch the parent menu key. For example, in Edit mode, you can latch the Track Menu key to show seven Track Menu-related option keys, including Unlock Height, Lock Micro, Lock Mini, Lock Large, Track Safe, Hide Track, and Un-Hide All. These options are also available when you right-click a track’s header, or click the Visibility icons on the Tracks pane of the Index Panel in the Fairlight page. When the picture keys are in Text Only mode, the Menu keys can be easily identified by the colored tag in the upper-left corner of the key.

**NOTE:** At this time, there is not an Un-Hide all tracks function on the Index panel in the Fairlight page. However, you can click your mouse on the Hide icon and drag it down over other hidden tracks to quickly swipe on or off track visibility. The Un-Hide All key is an example of a feature that is only available in the Fairlight Audio Editor.

– **Toolset Group Keys:** These are groups of similar operation keys that are placed together within an Editor mode toolset. For example, in Mix mode there is a group of Paste tools for pasting attributes from one track to others, including Paste EQ, Paste Dynamics, Paste Aux, Paste Path, Paste Plug-ins, and Paste All. This toolset group offers the same options that are available in the Paste Attributes sub-menu options in the Edit menu and right-click menu on a Track Header.

– **Toggles:** Toggle keys choose between a pair of options, often On or Off. In some cases, toggle keys toggle through multiple options. For example, in Record mode, the OSC key toggles the Oscillator on or off. However, the Input Monitor mode key toggles between all five Input Monitoring modes: Input, Auto, Record, Mute, and Repro. You can also latch the Input Monitor key to show the five input monitoring modes as menu option keys, similar to a drop-down menu. These same Input Monitoring modes are available via the Fairlight > Input Monitoring Style menu.
Open/Close: These keys open or close the associated panel or window on the Fairlight page interface. If pressing the key opens the panel or window, pressing the key again closes it, in most cases.

Action: Action keys cause an immediate result when pressed, such as Mark In, Mark Out, Trim Head, and Trim Tail in Edit mode.

Secondary Functions: Instead of reaching for the mouse for some commonly used operations, you can simply press the Control modifier key to reveal them as secondary functions in the picture keyboard. For example, press the Control key to transform the Mix, Edit, and Monitor mode keys into toggle keys to Show/Hide the Mixer, Index, and Meters panels respectively on the Fairlight page. Having the option to quickly show and hide these panels can really speed up your workflow.

Selecting a Clip vs a Range

The Fairlight page in DaVinci Resolve has two prioritized selection options for recording and editing functions, both of which use track selection to determine the contents included in the selection.

Clip selection: Selects clips beneath the playhead on a selected track or tracks. The exception is if clips are manually selected with the mouse. Clips that have been manually selected with the mouse are outlined in red and override selection based on the playhead and selected tracks. Clip selection is ideal if you only wish to edit a single clip or clips beneath the playhead on selected tracks.

Range Selection: Involves setting In and Out points in the Timeline by either using the In and Out keys, or marking either In or Out and moving the playhead to create a range. Marking a range automatically toggles on the Range key. Range selection allows you to select a portion of a clip or multiple clips on all of the selected tracks. When the Range key is latched, recording and editing operations may include all selected tracks within the range. If no tracks are selected, all of the timeline material within the Range boundary will be selected. This is useful if you are copying or cutting and pasting an entire range of the Timeline and pasting it elsewhere in the Timeline.

As you learn the different Record and Edit mode toolsets, remember that they will change based on the state of the Range key and the type of selection you have at the time of the operation.
Setup Mode Toolset

The Setup mode toolset is for the behind-the-scenes setup of operational elements that in many cases are set up when you start a project and left alone for the duration of the project. Here you’ll find specialized keys for setting up the Audio Editor’s functionality, toggling controls, or opening and closing settings windows that would otherwise require a mouse and menu selections on the Fairlight page. There are also some specialized setup keys that are only available on the Audio Editor, where you may wish to momentarily jump into Setup mode to enable or disable functions, then jump back to your current task.

Setup mode default toolset

Setup mode keys for new features or enhanced features only available in the Fairlight Audio Editor:

- **Video Online/Offline:** When toggled On (Online) the playhead is sync locked to the current video timecode in the Timeline. When toggled off (Offline), the playhead moves freely, and can be used to go to another area of the Timeline or Media Pool to add or edit a clip. Toggling this key back On (Online), returns the playhead to the exact position it was prior to going offline. This is a great way to temporarily move the transport offline so that you can go to a clip in another part of the Timeline, use the playhead as a sync point to copy or cut the clip, then toggle the Video back Online to jump the playhead and copied clip to the previous timeline location.

- **Display Setup:** This menu key reveals Display Setup Source keys to accommodate all of the Fairlight LCD screens on a console. Each Source key toggles between DATA, HDMI and SDI as needed.
Fader Spill: Temporarily spilling the member tracks of a master bus or VCA group to nearby faders is a fast way to finesse member track levels while mixing. Use this menu key to reveal two menu Spill option keys that determine the type of fader channel and direction in which member tracks are temporarily mapped to the adjoining faders on the Fairlight Channel Fader panel.

- **Spill Left/Spill Right**: This menu options key toggles between Spill: Left and Spill: Right, which in turn dictates whether the member tracks of a bus are assigned to neighboring faders to the left or right of a bus when Spill is engaged in the Channel Fader panel.

- **Spill Any/Spill Tracks**: When in the default (unlatched) state, the Spill: Any menu option allows member tracks of a bus to be spilled to the nearest faders to the left or right, including faders assigned to Master buses and VCA groups. When latched to the Spill: Tracks option, member tracks of a bus spill either left or right, starting with the nearest track fader in the designated direction. This option is useful if you need to maintain fader control of your buses while you spill their constituent tracks to the nearest track faders.

**NOTE:** Fader spill is engaged on the Channel Fader panel with a momentary-press on the Bank/Flip key, then latching the call button on a bus channel in the current fader bank. For more detailed instructions on using Fader Spill and creating custom Fader Banks, see Chapter 183, “Modular Fairlight Consoles.”

DL Off: This is the Decklink Offset key that lets you offset the Decklink Output so the picture and audio are in sync. Momentary press the DL Offset key and turn the jog wheel to increase or decrease the frame offset between 0 and 7 frames. This feature is also available in the Fairlight, Video I/O Offset section of the DaVinci Resolve User Preferences.

ADV In Jog: Latch this key to apply the Decklink Output offset while playback is in Jog or Shuttle mode. This feature is also available as a checkbox in the Fairlight section of the DaVinci Resolve User Preferences.

Talk Setup: This menu key reveals three menu option toggle keys to customize the Editor’s Talkback functionality:

- **Smart Talk/Push-2-Talk**: This key toggles between the default unlatched Smart Talk option and the latched Push-2-Talk option. Smart Talk allows the user to either latch the Talk button for extended hands-free talkback, or Push-2-Talk with a momentary press on the Talk button. Latching this key toggles on the Push-2-Talk mode, which limits talkback to the momentary-press Push-2-Talk method similar to using a 2-way radio.

- **GPI**: Talk/DIM/None: This key toggles the Monitoring Controls for the general purpose input (GPI) between None, Talk plus DIM, or DIM only.
– **GPO:** Talk/None/Armed/Record: Use this menu options key to determine when the general purpose output (GPO) sends a signal during a session. This key toggles between Talk, None, Armed and Record.

![Console Setup menu option keys](image)

– **Console Setup:** This menu key reveals toggle keys to customize the Editor functionality, including:

  – **Write Paste:** Toggle this key on if you want controls automatically placed in Write mode when pasting from one channel to another.

  – **Common Macros/Mixer Macros:** Use this key to choose whether the 14 macro quick keys remain the same (common) for both Edit and Mix modes, or if they change to macros 1-14 for Edit mode and 15-28 for Mix mode.

  – **Mode Jump/Wind:** This key toggles between Jump and Wind modes for the Rewind and Fast Forward keys above the jog wheel.

  – **Mixer Follows/Mixer Link:** Use this key to toggle the mixer between Follows and Link modes. When Mixer Link is toggled on, the mixer updates to show selected tracks in the Timeline. (Corresponding Resolve Preference > User > Fairlight.)

  – **Always Jog:** When this key is toggled On, any movement of the jog wheel will cause the transport to switch to Jog. Always Jog affects the wheel when the transport is not in motion and does not override Shuttle, Scroll, or Record operations.

  – **Trim from 0:** Toggles on Trim from Unity (0). You can use this in Mix mode while trimming fader automation. When toggled on, if automation is set to trim, faders armed to write will rest at unity where they can be manually adjusted from that position to trim the existing automation curve.

  – **Shuttle Fixed/Shuttle Free:** This key toggles between Fixed or Free Jog Shuttle mode.

  – **Jump/Wind:** This key toggles between Jump and Wind modes for the Rewind and Fast Forward keys above the jog wheel.

  – **Icon Buttons/Text Only:** Use this key to toggle the picture keys between Icon and Text or Text only.

  – **ALT Layout:** Latch this key to switch from the Normal layout to a new alternative text-only keyboard layout. This new Alt text-picture key layout shows keys that are relevant to the current task, with keys grouped toward the middle and lower rows of the keyboard for easy access. In this layout, the Editor Mode keys are located in the center of the the lower two rows of the picture keyboard. They are easy to spot with white text labels and a white line at the bottom of each mode key. The alternative layout also utilizes the six soft menu picture keys to the left of the jog/shuttle wheel for toolset group keys based on the current Editor mode and task at hand.

**To return to the normal layout of the picture keyboard, do the following:**

1. Press the white SETUP mode key, if necessary.

2. Press the yellow UTILS (Utilities) key. To reveal the Utilities menu options keys in the row above the UTILS key. The yellow tag in the upper-left corner of the UTILS key indicates it is a menu key.

3. Press the orange ALT LAYOUT menu options key to return to the normal layout.
Alt Layout with the SETUP mode key latched and the UTILS menu key on the far right unlatched

Alt Layout with the UTILS menu key latched and subsequent menu options keys in the row above including the latched Alt Layout key

**NOTE:** You’ll find pictures of each of the Alt Layout toolsets later in this chapter.

**Additional enhanced features only available in the Fairlight Audio Editor:**

- **Call Follows key:** In addition to selecting a track, there are other criteria for making a track active and “calling” its information into the Editor screen and corresponding Channel Control bay if you are on a Fairlight Audio Editor connected to a Fairlight console. These Call Follows menu options depend on the physical buttons, touch-sensitive knobs, and faders on the Fairlight console. The Call Follows menu key offers five Call Option keys that can be used alone or in combination to determine which track or master bus is active:
  - **Current Track:** When toggled on, the most recently selected track is the active track.
  - **Fader Touch:** When toggled on, touching a fader on the Fader panel makes it active.
  - **Pan Touch:** When toggled on, touching the Pan knob on the Fader panel makes it the active track.
– **Inline Touch:** When toggled on, touching any touch sensitive knob on the Channel Control panel, while set to Inline mode, calls that track and makes it active.

– **Solo Button:** Latching the Solo button on the Fader panel makes it active. Using a mouse or the Solo button on the Fairlight Audio Editor does not “call” the track active. Only the Solo button on the Fairlight Fader Control panel works in this scenario.

– **Undo Editor/Undo All:** This key is a matter of operator preference. When set to the default (unlatched), Undo Editor, tasks performed in Mix mode, including recording and editing automation data, will not be undoable. You can, however, simply record new mixing data to override the previous data as needed. Latching this key enables the Undo All mode, which in turn will undo all actions including automation applied in Mix mode.

– **CTI Fixed/Moving:** This key lets you choose whether the playhead (CTI) moves across the Timeline, or is fixed in place with the Timeline scrolling past.

– **Preview Track/Mon:** This key determines where preview monitoring goes when auditioning a sound and comes in handy when you need to preview a clip in the Media Pool or Sound Library. When toggled to Preview Track, you will put the track in Thru mode so it works like a live mic input and the sound you preview will be subject to the track’s fader levels, solo or mute state, and any processing applied to the track. If toggled to Preview Mon, the sound goes directly to the monitors without any processing or controls via the track’s channel strip in the mixer or console.

– **Normal Solo/Solo Follows:** This lets you customize how the Solo commands work. Normal Solo/Solo Follows is a bypass toggle for the Call Follows, Solo Button option. If the Call Follows, Solo Button menu options key is latched, and the Normal Solo/Solo Follows key is latched, soloing a track in the Audio Editor or Channel Fader panel “calls” that track’s information into the Editor display on the Audio Editor, and the Channel display in a Fairlight Console Channel bay. Unlatching the Normal Solo/Solo Follows key bypasses the Solo Call feature and returns Solo functionality to Normal Solo behavior, as the name suggests.

**Using the Playhead as a Sync Point indicator to sync sound to picture using Video Online/Offline key:**

1. With the Video Online/Offline key latched on, move the Playhead to the desired frame in the Timeline. For this example, let’s make it the frame where a door slams closed in the Viewer.

2. Unlatch the Video Online/Offline key so that it is offline.

3. Move the playhead to another location in the Timeline where there is a door closing sound effect that you’d like to copy.

4. Select the track with the clip you want to copy, and move the playhead over the frame that you want to sync with the door closing frame.

5. In Edit mode, press the Copy Clip key.

6. Latch the Video Online/Offline key so that it is Online. The playhead jumps to the previous location using the playhead as a sync point to match the door closing audio clip to the video frame of the door closing.

7. If necessary, press the Track Selection key for the track where you wish to paste the synced clip.

8. Press the Enter key to paste the clip.

**Record Mode Toolset**

The Record mode toolset is where you do your recording and offers specialized toolsets for both Manual and ADR recording. There are keys for every recording feature available on the Fairlight page including keys to open and close the Patch Input/Output window and ADR panels as well as rate takes without needing your mouse. Latch the ADR List, ADR Record or ADR Setup keys to open the associated panels on the computer screen. When either the ADR List or ADR Record keys are latched, you’ll see picture keys for each interface button in the associated workflows. For example, latching the
ADR Record key reveals a set of seven specialized keys for ADR Recording, including Previous Cue, Next Cue, Previous Take, Next Take, Rehearse Cue, Record Cue, and Play Cue. These keys work exactly the same as using a mouse and keyboard on the ADR Record panel in the Fairlight page interface.

The Fairlight Audio Editor includes a special set of Manual recording options that are only available on the Editor. These options use either playhead, clip, or range boundaries, as well as user-defined pre-roll and post-roll that can be set in the User Preferences, Editing panel.

**NOTE:** When recording in the Fairlight page, tracks must be armed before recording, and only tracks with inputs patched to them can be armed. Luckily, there is a key in the Record Mode toolset for opening the Patch Input/Output window. Use a momentary press on the Record key and Latch a Track Selection Key to arm that track.

---

**Record Mode Manual Recording special toolset keys include:**

- **Record Here:** Playhead goes back the pre-roll duration, then punches into Record at the location where you issued the command. This can be useful when you zoom in to find the exact timecode position where you want to punch in to record, then simply issue this command by pressing the Record Here key and the system does everything for you.

- **Record Range:** The playhead includes a pre-roll and punches into Record at the Range In point, and then punches out at the Range Out point.

- **Record Clip:** After pre-roll, the playhead punches in and out to match the duration of the clip under the playhead on the selected track. If no clip is beneath the playhead, the transport moves forward to the next clip in the track and records there.

- **Record Again:** Pressing this key repeats the last recording you made, both entry and exit, whether it was manually or automatically punched in.

- **Punch In Again:** The system pre-rolls, then enters record at the exact same place as last time, whether it was manually for automatically activated. When entering this record operation, you still need to manually punch out. This allows you to get the same start point for recording but with a manual exit.

- **Record Head:** Pre-rolls, then starts recording at the head of the first clip to come beneath the playhead in the selected track. When entering this record operation, you still need to manually punch out.

**Monitor Mode Toolset**

As the name suggests, this mode is for setting up your monitor system. In most cases, this is set up at installation, but there are also controls for setting up the monitors for a particular session and quickly switching between different sources, including external sources, speaker sets, and surround formats.
You can even mute any of the current speakers by latching its associated picture key marked with a Speaker icon.

Monitor mode default keys showing Control Room monitoring.

**Monitor mode keys for enhanced features only available in the Fairlight Audio Editor:**

- **C/R / Studio toggle:** This key toggles the Monitor mode keys between Control Room (C/R) and Studio monitoring keys.
- **Phase:** Hold this key and press any speaker button to toggle its phase.
- **Alt Source:** Use this key to toggle between the Main system bus and the most recently selected Alternative source. The standard monitoring source is the Main system bus. However, you can choose many other sources, including other system buses or external sources, such as a CD player. The system remembers the last non-standard source that you chose as the Alternative source.
- **Mono Comp:** If your current speaker set is not mono, you can press this button to monitor playback in mono.
- **Stereo Comp:** If the current speaker format is not stereo, you can press this key to monitor the playback in stereo.

**Macros Mode Toolset**

Macros are programmable keys where you can record sequences of keystrokes. The Macro mode toolset includes 30 programmable Macro keys, as well as Delete, Rename, and Record keys for recording and managing your macros. The first 14 Macro keys are also assigned to the Macro quick-keys at the top of the Audio Editor’s display (Pad). Macros can record any keystroke on the Fairlight Audio Editor, including a momentary press to enter a different mode and keypresses in that mode during the momentary press. For example, it is common, when recording a macro, that you start in the mode with the first key you want to record, then momentary-press the Macro mode key to enter Macro mode just long enough to start recording the macro. Upon releasing the Macro mode key, the first key you press on the original mode will be the first one recorded.

The most important thing to remember when recording macros is that they are reliable once created, but have no context except what you program. It’s a good idea to think of the starting and ending context for your macro prior to recording. For example, if the macro requires moving clips from one track to an empty track, make sure you create the new track before executing the macro. If the macro uses jump keys, make sure you have them set up ahead of time and so on. It is up to the user to remember a starting point and ending point, if relevant. Once a macro has been recorded, the associated quick key at the top of the Editor lights up to show that it is available as a macro.
**NOTE:** To prevent accidentally recording, renaming or deleting a Macro key, the Macro action keys require a momentary press plus a numbered Macro key.

**Macro Mode action keys:**
- **Delete:** Press and hold this key and press a Macro key to delete the macro.
- **Rename:** Press and hold this key and press a Macro key to open the User Macros dialog and rename the macro.
- **Record:** Press and hold this key and press a numbered Macro key to record. Press Control and the Menu key to stop recording. The Menu modifier key changes to Menu (rec) when recording a macro and Stop Recording when you press the Control modifier key while recording a macro.

**Recording a Macro:**
1. Set up the Editor for whatever steps you plan to record in the Macro and latch that mode.
2. Momentarily press the Macros mode key to enter that mode temporarily.
3. Do not release the Macros key.
4. With the other hand, in the Macro mode toolset, momentarily press the Record key and the numbered Macro key that you want to record. Release the Record and numbered Macro key.
5 Release the Macros mode key to return to the latched Editor mode.
6 Press the keys one at a time as needed to complete the steps that you want to record to the macro.
7 Stop playback, if necessary.
8 Press the Control key and press the Stop Recording key in the modifiers section of the keyboard.

**NOTE:** You can take as long as you need to record a macro, and if you make a mistake you can either delete the macro or re-record it using the Delete or Record keys.

**Example of recording a simple macro to move a clip from one track to the track below:**

1 Prepare the Editor for recording the first macro. In this case, press the Edit mode key and latch the A1 track selection key to select that track. Move the playhead over the first clip in the track.
2 Momentary press the Macros key with the left hand. Do not release the Macros mode key.
3 In the Macros toolset, press the Record key and the Macro 1 key, to initiate recording of the Macros 1 key. Release both keys. The Macros keys disappear from view in the Macros toolset.
4 Release the momentary press on the Macros key to return to the Edit mode. The next keypress will be the first recorded to the Macro 1.
5 Press the Cut Clip key to cut the clip on the selected track beneath the playhead.
6 Press the Down key to the left of the jog wheel to move the track selection, and the shadow of the clip that was cut, down one track.
7 Press the Enter key to paste the clip.
8 Press the Up key next to the jog wheel to move the selection back up to the A1 track.
9 Press the Control modifier to change the Menu key to a Recording Stop key. Press the Recording Stop key.

From this point forward, pressing the Macro 1 key in the Macros Mode toolset, or the Macros 1 quick key at the top of the Editor will perform the macro of cutting a clip on one selected track and moving it to the track below then returning to the original track. With this macro, you could easily use jump keys to move down the Timeline a clip at a time, and move any clips that need to go to the A2 track with the press of the Macro 1 key.

**NOTE:** You could also use this same macro to move a clip from any selected track to the track below because it contains the Up and Down arrow keys instead of specified track selection keys. Additionally, you could take this macro idea to a whole new level and include jump keys and fades at the edges of the clips as you edit.

**Renaming a Macro key**

1 Enter the Macros mode toolset.
2 Long-press the Rename key and press the Macro key that you want to rename.
3 In this case Macro 1. Release both keys.
4 The picture keyboard changes to QWERTY keys and the User Macros dialog opens on the computer screen.
5 Type a new name for the Macro and press Return.
6 The Macro is named in the Macro mode keys.
If you are going to name your macros, it's a good idea to give them a brief but literal name to help you remember the macro's function. In the above example, the macro was named A1 to A2 because it was designed to move a clip from the A1 track to the A2 track.

Mix Mode Toolset

Whether you are using the Fairlight Audio Editor with your computer, or as part of a Fairlight Console, the Editor’s Mix mode offers easy access to a powerful array of mixing and automation tools. Here you can copy and paste EQ, Dynamics, Aux, Path, Plug-ins or all of the above to other tracks and buses as well as automate any parameter. The heart of the Mix mode toolset is the Mix On/Off key. Latching Mix On brings all of Fairlight’s powerful automation tools and menu options to the picture keyboard so you can control every aspect of your automation without ever reaching for the mouse. If you are familiar with Fairlight’s mixing and automation tools in DaVinci Resolve, you’ll have no trouble finding your way around this toolset because there is a picture key for every switch, toggle, menu, and sub-menu option available in the Fairlight page’s robust automation toolset.

The functionality of each specialized key is exactly the same as using the software alone. However, the advantage of mixing with the Fairlight Audio Editor or a Fairlight Console is that you’ll have physical controls including touch-sensitive knobs for precision automation recording and mixing maneuvers without the distraction of a mouse and menus.

For a detailed rundown of the Fairlight Automation tools and features, please refer to Chapter 176, “Automation Recording.”
The Mix Mode automation keys are organized and grouped as action keys, toggles and menus with related submenu keys with the same tools and menu choices that you'll find on the Fairlight page and Fairlight menu in DaVinci Resolve.

**Mix Mode toolset toggles, groups, and menu keys:**

- **Copy/Paste**: This key automatically toggles on when automation is turned off. You can manually latch this key while the automation toolset is showing. When latched, the Copy/Paste key reveals the Copy and Paste toolset group.

- **Copy and Paste Toolset Group**: When the Mix On key is unlatched, the Copy/Paste key latches, and you will see a Copy key next to a toolset with six paste action keys, including Paste EQ, Paste DYN, Paste AUX, Paste PATH, Paste PLUGS, and Paste ALL. These keys are all used to copy attributes from the active track and paste them on a selected track. To use these keys, press the Copy key to copy all of the track attributes for the active track. Select another track and choose the Paste action key that corresponds with the attributes you want to paste to the newly selected track.

- **Mix ON**: This key toggles on or off the Automation toolset. When toggled on, the Copy/Paste key toggles off and the Copy and Paste toolset group switches to the automation specific toolset such as the Mix, Punch Menu, and Preview menu keys.

- **Automation Menu keys**: Enable, Mix list, Mix Menu, Punch Menu, and Preview Menu all reveal a set of submenu option keys when latched. The subsequent option keys offer the exact same options available on the Fairlight page interface. For example, latching the Enable menu key reveals ten option keys that represent each of the ten Enable buttons on the Fairlight page Automation toolbar, in the exact order that they appear onscreen. The Enable option keys are as follows from left to right: Write FADER, Write MUTE, Write PAN, Write EQ, Write COMP, Write LIMITER, Write AUX, Write PLUGINS, Write MISC, including a dedicated All button.

- **Open/Close GUI window keys**: The Patch, Mix List, and Presets keys open and close the corresponding windows on the computer screen.

- **Toggles**: The Touch and @Stop keys toggle between the different Touch and Stop automation modes when toggled. The Touch toggles between OFF, LATCH, and SNAP while the @Stop key toggles between RETURN, EVENT, and HOLD.

- **Preview Menu**: Switches the Automation controls into Preview mode for auditioning settings without writing new automation data and offers Preview menu option keys including; Fill Range, Glide Range, Punch In, and Punch Out.

- **Safe Menu**: This new automation option provides the ability to specify an active automation zone with Safe In and Safe Out keys where the system does not receive timecode automation outside of the specified range. When Safe automation mode is active, automation Read and Write functions are only available within the safe range and are disabled outside of the designated safe range.

- **Write Quick Keys**: Write FADER, Write MUTE, Write PAN. These keys can be used to quickly enable the three most common Automation parameters.
Edit Mode Toolset

If you’ve read the previous Fairlight chapters, you’re already familiar with the Audio Editing tools and menu options. The Edit mode toolset includes over twenty specialized picture keys for adding, moving, editing, and trimming clips in the Timeline. The keys represent all of the audio editing options available in the Fairlight page via the Edit and Trim menus as well as a handful of tools that are only available in the Audio Editor. You’ll also find keys to open, preview, and edit clips from the Sound Library and Media Pool.

Fairlight audio editing is by nature fast and fluid, even when you are working with the software and computer alone. Where the Fairlight Audio Editor enhances the process is that with the combination of the jog wheel and Edit mode action keys, you can move and edit clips at incredible speeds and even edit clips on the fly without ever picking up your hands. In fact, the Fairlight Audio Editor is designed for two-handed operations. The added functionality of two-handed workflows really comes into play when working in the Edit mode. For example: with your left hand, you can easily select tracks and press action keys, while you use your right hand to drive the jog wheel controls and press the Enter key to paste material that its copied to the clipboard.

The Edit mode action keys work off of two principals: removing material you don’t want to keep in the Timeline, or moving material to another location. To remove material, you use tools that erase or trim. To move material, you use the Clipboard tools that cut or copy and therefore store the material in memory to be pasted elsewhere. When you cut or copy material, a semi-transparent version of the Clipboard clip appears in the Timeline and can be moved to another track or location and pasted. Another consideration when editing is to determine if you are modifying the head, tail, whole clip, or a range containing only part of a clip or multiple clips. All audio edits are non-destructive and reversible with the Undo key.

**NOTE:** For more details about the fundamentals of editing audio clips in the Fairlight page, please refer to Chapter 172, “Editing Basics in the Fairlight Page.”

**Default Edit mode actions and associated keys include:**

- **Cut:** Cut Head, Cut Clip, Cut Tail keys all cut the material based on the selected track, clip and playhead position and place the removed material in the clipboard for pasting with the Enter key. For more fluid editing, hold down a Cut key, such as Cut Tail, and use the jog wheel to move the cut portion of the clip to a new location, then release the Cut Tail key to automatically paste the cut clip in the new position.

- **Copy:** Copy Head, Copy Clip, Copy Tail keys all copy the material based on the selected track, clip and playhead position and place the copied material in the clipboard for pasting with the Enter key.
– **Trim**: Trim Head, Trim Tail uses the playhead’s position to remove the current clip’s head or tail. You can also press and hold Trim Head or Trim Tail while using the jog wheel to extend either the head or tail of the current clip. While doing this, you see the full waveform the clip you’re trimming as you turn the jog wheel, but when you release the Trim Head or Trim Tail button, the Head or Tail of the selected clip appears trimmed at the current frame at the playhead.

– **Split**: The Split key splits the clip at the playhead position creating a new edit point between two clips.

– **Fade**: The Fade Head and Fade Tail keys add fades respectively from the playhead to the head or tail of a clip.

– **Erase**: Erase clip deletes the clip from the Timeline.

– **Batch Fades**: Long-press this key to open the Batch Fades Settings window or press to execute Batch Fades for the current audio clip or range selection.


**Edit mode actions when Range is active:**

– **Cut Range**: Use this key to cut all clips and partial clips within the range on the selected track or tracks. The Cut Range key replaces the Cut Clip key when Range is toggled on. This cuts clips within the range on all selected tracks.

– **Copy Range**: Use this key to copy all clips and partial clips within the range on the selected track or tracks. The Copy Range key replaces the Copy Clip key when Range is toggled on. This copies clips on all selected tracks within the range.

– **Split Range**: This key splits any clips lying across the range boundaries into two pieces at the range In Point and Range Out Point. This affects clips at the range boundaries on selected tracks.

– **Erase Range**: Erase Range deletes the range from the Timeline. This Erase Range key replaces the Erase Clip key when Range is toggled on.

**NOTE**: For ease of use and quick mastery, the Edit mode action keys are logically grouped in pairs or trios so that keys involving the head of a clip are first and tails are last. For example, the Cut Head, Cut Clip, and Cut Tails keys are grouped together as a trio. Placing three fingers over those keys make it easy to remember the first key is the head, middle key is the full clip, and last key is the tail.

In addition to the default Edit mode action keys, there is also a set of refinement action keys that can be used to finesse edits, fades, and clip positions. The refinement action keys require the Control modifier key as well as the jog wheel in most cases. These refinement action keys are logically placed for quick decisions so you can first execute an edit and then refine it without lifting your left hand or searching for a refinement key.

**Control modifier-based editing refinement actions and associated keys include:**

– **Erase**: Erase Head and Erase Tail keys appear on the same keys as Cut Head and Cut Tail so that you can quickly choose between a cut, which keeps the material in the clipboard and erasure of the material, with the touch of your left Pinky finger on the Control key.
– **Fade:** Head X-Level and Tail X-Level keys appear on the Fade Head and Fade tail keys so that you can first add a fade, then press Control and use the same key to refine the fade level with the jog wheel. Additionally, long-press SHIFT to reveal Head XPoint and Tail XPoint that can be changed with the jog wheel or long-press CTRL + SHIFT to use the jog wheel to refine Head Shape and Tail Shape.

– **Slip:** Slip Head, Slip Clip, and Slip Tail keys are located on the same keys as Copy Head, Copy Clip, and Copy Tail. That way you can seamlessly copy, move, and paste material to a new location, then hold the Control key while pressing the respective Slip key, and turn the jog wheel to refine the Head, Clip position or Tail based on the jog movement of the playhead.

– **Trim:** The Trim Clip refinement tool shares a key with the Split Clip key so that you can split a clip at the playhead position, then hold Control and the same key while using the jog wheel to refine the position of the edit point created by the split.

– **Clip Level:** This key plus the jog wheel and the Control modifier key adjusts the Display level of the selected clip’s waveform.

– **Jog Wheel:** To place the playhead (CTI) at either the In or Out point of a range, use Control plus the jog wheel. Hold Control while turning the jog wheel to the left to move the playhead to the In point. Hold Control while turning the jog wheel to the right to move the playhead to the Out point.

### Edit mode keys for enhanced features only available in the Fairlight Audio Editor:

The Edit mode tools work exactly as expected if you are familiar with the Fairlight page in DaVinci Resolve. There are, however, a few specialized keys that don’t have counterpart tools in the Fairlight page. These unique tools perform valuable time-saving tasks.

– **Clip Level:** This key is both a Menu and Jog Wheel modifier key. Hold the Clip Level key to reveal seven option keys to raise or lower the selected clip’s volume up +/- 3 dB. Incremental menu options keys from left to right include: -3dB, -2dB, -1dB, 0dB, +1dB, +2dB, +3dB. As a Jog Wheel modifier key, hold the Clip Level key with the left hand and turn the jog wheel with the right hand to raise or lower the clip’s volume level dynamically based on the amount and direction that you turn the wheel. This can be performed on the fly during playback, so you can dial up or down the volume level of any clip on the selected track as the playhead passes over the clip. Clip level changes can also be applied to multiple clips on multiple selected tracks simultaneously.

**NOTE:** At the time of this printing, the Edit page in DaVinci Resolve includes a Clip menu option and keyboard shortcuts for incremental decibel changes, however there is no comparable shortcut, or menu in the Fairlight page.

– **Reverse Clip:** This key is available as one of the Clip Menu action keys. When pressed, this key reverses the clip beneath the playhead on the selected track. This creative sound design tool is also available in the Record mode Clip Menu toolset.

– **Range Menu Keys:** A momentary-press on the Range key reveals six invaluable Range-defined tools for speeding up your tasks. Although they are also available in the Record and Mix mode toolsets, you will primarily use them in Edit mode.

– **Copy Segment:** This action key copies all timeline material within a marked range.

– **Paste Segment:** This key pastes a copied segment to a new timeline location based on the playback position.

– **Previous Gap:** Use this key to extend a range by moving the range In Point to the previous gap in the selected track or tracks.

– **Next Gap:** Use this key to extend a range by moving the range Out Point to the next gap in the selected track or tracks.
– **Fill**: Fills the current range on a track from end to end with the clipboard clip. Without the need to cut, copy and paste, Fill automatically duplicates the clipboard clip, with a slight overlap and fade to stitch together background noise or room tone within the marked range.

– **B/F Fill**: Back/Front Fill works exactly the same as Fill, except that it reverses the audio in every second copy of the clipboard used for filling. Alternating the direction of the stitched clips is useful for creating a seamless background sound because the waveform is continuous.

### Alternate Picture Key Toolsets

In the Alternate picture key layout mode, all of the picture keys are text only, with the Editor mode keys arranged in the lower center white text. The menu keys are easy to spot with yellow text and a mark in the upper left corner. Alternate Edit, Monitor, and Mix mode toolsets include action keys in the six soft keys to the left of the jog wheel for quick access. For example, in Edit mode, the Cut, Copy, Erase, Fade, Nudge, and Trim action keys are all located in the upper-left corner of the picture keyboard, while the action keys associated with the active action key appear in the picture keys near the jog wheel. For example, if the Copy action key is latched, the Copy Clip, Copy Head, and Copy Tails keys are available near the jog wheel. If you latch the Cut action key, the middle keys near the jog wheel change to Cut Clip, Cut Head, and Cut Tail.

Alternate picture key toolsets include the same keys as the default normal layout. The difference is the location of the keys, how they are grouped, and the additional usage of the picture keys near the jog wheel.
Alternate Record toolset

Alternate Monitor toolset with Phase, Main/Near Speaker selection, and Alt Source keys available near the jog wheel

Alternate Mixer toolset with Mix On unlatched, Copy/Paste latched, and Copy/Paste keys available near the jog wheel

Alternate Mixer toolset with Mix On latched and Mix automation keys available near the jog wheel
TIP: One way to get to know your way around the Audio Editor keyboard is to start with knowing how to perform a task in the Fairlight page using a mouse and standard keyboard. Then, consider which Editor mode category the task belongs to, and find the associated keys from there. Making the transition from mouse and keyboard to the Audio Editor is a journey of discovery where you will find numerous ways to execute different tasks, shortcut keys and advanced controls and options that can increase your speed and productivity exponentially the longer you use it.

Editor Screen with Soft Controls

The Editor screen, located above the picture keyboard, displays all signal processing and mixing information related to the most-recently-selected (active) track or master bus. It also displays labels and visual feedback for the soft keys and knobs that surround the screen. Additionally, the ALT key below the screen extends its functionality with an alternative set of parameters when necessary. This is where you can quickly view and adjust various mixing parameters associated with the active track or master bus. Whether you select a track manually with a mouse click, press the associated Track Selection key on the Audio Editor, or latch a Channel Select button on the Fairlight Channel Control panel, the most-recently-selected track’s parameters appear in the Editor screen.

These parameters include Level and Pan, EQ, Dynamics and AUX, and Plug-in parameters that correspond with the active track of bus. The graphical display for signal processing remains the same in the Editor screen for nearly all Editor modes and types of signal processing, except for Monitor mode and Aux signal processing.

As you learn your way around the Fairlight Audio Editor you’ll soon find that glancing at the Editor screen is akin to glancing at your dashboard while you drive your car. Following this example, your primary computer screen is like your windshield where you can always see what is happening as you drive the Fairlight Console or Audio Editor. However, like a dashboard, you can glance at the Editor screen at any time to see which track or master bus is selected, as well as the current signal processing settings. Also, like your car’s dashboard, you can reach out and change settings for any of the interactive graphical parameters by simply choosing that element and modifying the adjacent controls.

At this time there are five different Editor Screen layouts that you will encounter while you work with the Fairlight Audio Editor, including Clip EQ, Standard Mixing, Plug-In, Aux sends, and Monitor mode layouts.
The Clip EQ layout gives you soft menu controls of the 4-Band EQ parameters for the selected clip when you latch the Clip EQ key. The Clip EQ key is one of the Clip Menu option keys available in the Record and Edit mode toolsets. Here you have all the same EQ controls that are available in the Clip Inspector in DaVinci Resolve. Along the top of the the second page of Clip EQ controls (shown above), you’ll find new Clip EQ preset options that are not currently available in the Fairlight page UI. These options include: Save Preset, Apply Preset, Copy, and Paste.

Standard Mixing layout used in all Editor modes, except Monitor, or when the Aux controls are showing. At a glance you can see that the Pan controls are active based on the illuminated soft button in the bottom row with the bright red line over the Pan label adjacent to the latched button.

Plug-In layout used to control first plug-in on the selected track and is available in all Editor modes. except Monitor mode and when Aux controls are showing. The Plug-In Editor screen controls include a three page layout. Page 1 provides the Insert IN toggle to bypass the plug-in. Page 2, shown above, has toggle options to Reset the plug-in as well as options to Save, Load, and Apply presets, Automate, and Lock the plug-in. Page 3 offers Mapping mode where the user can map specific plug-in parameters to the six Editor rotary knobs.
Aux layout showing send levels and panning for up to 24 Aux channels simultaneously. In this example, the sends for Aux 1 and Aux 3 are enabled (green) for the active track, while Aux 2 has been disabled for this track. The soft buttons along the top enable the different Aux channels for the active track. Red text over black labels indicate which Aux channels and soft buttons are toggled On.

Monitoring mode layout with visual feedback for Dim and Fixed levels, Control Room, Loudness, and Studio meters, as well as a graphical representation of the speaker configuration and listening environment.

**Visual Feedback between Soft Controls and the Editor Screen**

The Editor screen offers highly visual feedback that is easy to follow and corresponds with the identical controls in the Fairlight page, as well as the visual feedback on the Channel bay if you are working with a Fairlight Console. When looking at the soft buttons and touch-sensitive knobs, here are some guidelines to help you recognize their current state and options:

- Soft buttons and knobs around the Editor screen directly control the closest on-screen parameter.
- The soft buttons above and below the screen have three visual states; Bright, dim and off.
- At a glance all soft buttons with adjacent controls are illuminated (dim), while soft buttons without controls are black (off).
- The upper row of soft buttons are toggles that either toggle a parameter On/Off or toggle between options, such as the type of curve for EQ filtering. The last soft button on the top row toggles between pages of controls.
- Soft buttons above the Editor screen brighten when active or latched on, and the corresponding soft menu control onscreen shows in black with red text.
- Soft buttons below the Editor screen display alternative pages of controls assigned to the left and right knobs.
- It is easy to identify which page of controls is active because the latched soft button below the Edit screen is illuminated along with the adjacent label that is also marked with a bright red line.
– When you touch one of the knobs to adjust the current settings, the background of the corresponding visual feedback onscreen darkens.

– You can reset any of the parameters controlled by a touch-sensitive knob by pressing the Control key then touching the knob.

– Hold Shift while turning a knob for fine incremental control.

– The first and last soft buttons on the bottom row are modifier keys that offers momentary control of additional parameters for the controls for the knobs when available. For example, when the Aux controls are shown in the Editor screen, the knobs control the send level. While, a momentary press on the modifier soft button changes the knob controls to the Aux channel Pan settings.

Visual cues, like the red line over the illuminated soft button below the screen and the darkened parameter control next to the active knob on the left of the screen, indicate which EQ parameters are currently assigned to the control knobs, as well as which touch-sensitive knob is in use.

Macro Quick Keys

The top row of the Fairlight Audio Editor is dedicated to the Macros quick keys. Here you’ll find Macro quick keys for triggering each of the first 14 programmed macros. Once a Macro key has been recorded in the Macro mode layout, the associated Macro quick key illuminates to show it can be used to trigger the corresponding macro. These are a fast way to use macros as you work, without switching to the Macro mode toolset.
Chapter 183

Modular Fairlight Consoles

The modular Fairlight consoles make it easier to perform audio editing, recording, and mixing tasks by providing professional audio controls for nearly every function and feature in the DaVinci Resolve Fairlight page. Additionally, using a Fairlight console to control the Fairlight page is vastly more efficient and ergonomic than working with a traditional mouse and keyboard. This is especially important when your audio post-production job requires long hours doing complex, focused, and often repetitive work.

This chapter covers details about the different modular Fairlight console components, the available console configurations, and how they work with DaVinci Resolve.

**NOTE:** To set up a modular Fairlight console to work with your DaVinci Resolve system, you first must perform a custom installation of DaVinci Resolve and check the box to include the Fairlight Control Panels utility.

For complete setup and installation instructions, refer to the Fairlight Console Assembly Instruction Manual. DaVinci Resolve 17.2.1 requires a firmware update for each of the modular panels. See instructions for updating the firmware via the Fairlight Control Panels utility at the end of this chapter.

Contents

- About the Fairlight Console Components 3455
- Fairlight Console Audio Editor 3458
- Channel Control Modes 3459
- Fairlight Console Channel Control 3461
- Channel Control Buttons and Channel Control Knobs 3466
- In-Line Channel Extension Buttons 3468
- Fairlight Console Channel Fader 3469
- LCD Fader Channel Display 3470
- Rotary Knob 3470
About the Fairlight Console Components

Fairlight consoles are a modular design that let you build your console to suit your production requirements. Within each console, four different Fairlight console components work together as Fairlight page control panels in a stand-alone chassis. These modular console components are either channel bay panels or audio-editing bay panels, and are paired with an adjoining Fairlight LCD Monitor component. The channel bay components work in tandem to control specific parameters on tracks, buses, and mains and include the Fairlight Console Channel Control, the Fairlight Console Channel Fader, and the Fairlight Console LCD Monitor that is used as a dedicated channel control screen. The audio editing bay components consist of the Fairlight Audio Editor and adjacent Fairlight Console LCD Monitor, which mirrors your computer screen and displays the DaVinci Resolve interface.

Four different Fairlight console configurations range in size from 2-bay to 5-bay, with each bay spanning the width of a console module. The primary difference between the Fairlight consoles is the number of channel bays they contain. For example, a standard Fairlight console 2-bay comes with one set of channel bay panels plus one set of audio editing bay panels for a total of three control panels and two LCD screens, while a standard 5-bay console includes enough panels to fill four channel bays and one editing bay for a total of nine control panels and five LCD screens.

Because you will still need to control your computer and other software functions from the console, it is also important to have a wireless keyboard and mouse within reach. To accommodate wireless computer controls, Fairlight consoles include a Channel Control Blank and an Infill module. The Channel Control Blank fits in the Channel Control slot between the Audio Editor and editing LCD monitor, and easily holds a full-sized wireless computer keyboard. The Fairlight console Infill module provides a convenient flat surface for a wireless mouse, track-pad, or notebook. You can place the Infill module at the left or right of any bay within the console chassis. The most common Infill position is on...
the right side of the audio editing bay; however, a left-handed sound designer may prefer to place the Infill set on the left side of the editing controls.

Each self-contained modular console is designed to meet the demands of modern work flow ergonomics and ease of use so that audio editors, sound designers, and re-recording mixers can quickly and accurately complete both simple and highly complex audio post-production tasks with minimal fatigue.

This chapter provides details and functions descriptions of each console component and should be read in conjunction with the previous Fairlight chapters to get the best from your console.
The Fairlight Console Channel Control is a multi-functional panel that works in conjunction with the Fairlight Console Channel Fader and LCD Monitor to provide 12 groups of touch-sensitive control knobs, buttons, and visual feedback for each of the 12 fader channels. These controls offer instant access to the parameters available in the DaVinci Resolve Fairlight page Mixer.
For precision recording, mixing, and mastering, the Fairlight Console Channel Fader module offers 12 touch-sensitive motorized faders and Pan knobs with corresponding Fader Channel Control buttons, automation controls, and bank buttons for mapping tracks and buses to the 12 faders.

**Fairlight Console Audio Editor**

The legendary Fairlight Console Audio Editor lets you quickly navigate large projects and precisely edit audio much faster than using a regular mouse and keyboard. The Fairlight Console Audio Editor has an identical feature set and controls as the Fairlight Desktop Audio Editor. The difference is that the Console Audio Editor is connected to all the console’s control panels, so recording, playback, and editing functions are reflected on the corresponding channel bays and vise versa. For example, if a track is called in the Fader Panel, it is also loaded in the Audio Editor’s built-in display. Another example is if a track button is selected in the Audio Editor, the track is also selected in the Fairlight Page interface on the Editing LCD monitor, and the corresponding selection button shows active in the In-Line Channel Control Extension buttons as well as the Channel Control LCD monitor. A Fairlight Desktop Audio Editor can also be connected to a Fairlight console that does not include an Audio Editing bay.

For details on the Fairlight Console Audio Editor’s features and functions, see Chapter 182, “Using the Fairlight Desktop Audio Editor.”
Although the three channel bay components are separate modules, they work together in tandem as a single multifaceted unit to display and control various channel parameters. The Channel Fader panel offers traditional channel mixing controls, while the multi functional Channel Control panel focuses on controlling specific parameters as needed as well as how they are displayed on the Channel LCD monitor.

**Channel Control Modes**

Within a Fairlight channel bay, the Channel Control panel works in three distinct channel control modes. These modes, in turn, change the functions of the multipurpose channel control knobs and buttons as well as the corresponding display in the LCD module:

- **In-line:** This mode effectively separates the knobs and buttons on the channel control module into 12 groups that line up vertically with the 12 faders on the channel fader control. As the name suggests, in-line mode shows each set of parameters in a line that continues from the fader channels up through the channel controls and into the display on the LCD monitor. In-line Display buttons on the right side of the Channel Control panel determine which in-line parameters are shown. This mode is common in live recording so that the operator can easily see and control parameters of multiple microphone inputs simultaneously.
- **Channel**: Use Channel mode to control up to 192 parameters on one channel. In channel mode, the 12 groups of controls on the channel control module are used collectively to adjust parameters for a specific channel from left to right as displayed on the LCD Monitor. In Channel mode, there are several ways to choose which channel is displayed, including the Channel Call buttons on the Channel Fader panel, the Channel Select buttons on Channel Control panel, the Call Follows menu, the edit controller, or by selecting a track in the Fairlight page Timeline or Mixer. This is the most common channel control mode in audio post production, as it provides quick access to all parameter controls for a specific track.

Channel Control components in Channel mode

- **Master**: This mode utilizes all channel controls to adjust parameters for the buses and main output. In Master mode, the 12 groups of controls on the channel control panel adjust the adjacent main output parameters displayed on the LCD. The channel controls in Master mode are organized from left to right in order of processing. Master mode is commonly used while mixing and mastering soundtracks.

Channel Control components in Master mode
Fairlight Console Channel Control

The secret to managing high track counts for large projects is the Fairlight Console Channel Control because it provides instant knob-per-function access to channel parameters along with real-time high resolution visual feedback on-screen. The Fairlight Console Channel Control module fits directly below the LCD monitor so that you can always see the graphical representation of each parameter as it is modified with the adjacent channel controls. There are four types of channel controls organized in three areas of the panel.

On the far left and right sides of the panel, you’ll find dual-function Channel Display buttons that determine the current channel control mode and which parameters are displayed on the LCD monitor.

The middle of the panel contains 12 groups of multi functional Channel Control buttons and knobs that align with the 12 faders on the Channel Fader panel. The knobs are used to adjust parameter values, while the control buttons act as toggles, On/Off, or In/Out switches for active parameters.

The fourth type of controls are the In-Line Channel Extension Buttons, which are arranged in groups of six below each of the 12 channel control groups. Here you’ll find dedicated channel-specific buttons for functions available in the Fairlight page Mixer and Timeline track headers.

The primary display controls for the channel control components are the dual-function channel display buttons located on the left and right sides of the Channel Control panel. These bi-colored LED buttons determine the channel mode and current parameters displayed on-screen. There are a total of 16 display buttons split evenly into groups of eight buttons on each side of the panel. On the left side of the panel, you’ll find eight channel display buttons used to select the channel control mode as well as display plug-ins and automaton parameters; while the display buttons on the right side of the panel are used to show the in-line channel parameters found in the Fairlight page Mixer, such as Pan, EQ, and Dynamics. The top and bottom display buttons are identical on both sides of the panel to provide easy access to the CTL (control) and ALT (alternate) functions for selecting secondary display features, resetting parameters to default values, and showing alternate controls in the LCD.

The default color for all display buttons is yellow, except for the Control button, which is always blue. When the Control button is pressed, inactive display buttons with secondary functions turn blue or purple. Active display buttons remain in their active state color until another display button is selected. For example, if a secondary function is selected, that display button remains purple as long as it is active, while the other display buttons return to yellow when the Control button is released.
Left side of panel, Channel display buttons from top to bottom:

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTL:</td>
<td>This display button is the same as the Control modifier key on the computer keyboard and can be used to switch to the secondary functions for the dual-function display buttons below. The handy blue color makes it easy to locate and use as needed, to switch inactive display buttons to their secondary functions. Additionally, holding the Control button while touching one of the knobs or faders will reset any of the touch-sensitive controls to their default values. For example, holding the Control button while touching a fader or Aux send knob resets the value to 0 dB and is the Fairlight Console Control equivalent to double-clicking the mouse on a fader or knob in the Fairlight page GUI. There are a total of three conveniently located Control buttons on a Channel Control bay; two on the Channel Control panel, and one on the Channel Fader panel.</td>
</tr>
<tr>
<td>MSTR/U1:</td>
<td>This button is used to set the channel controls to Master mode which displays all the system bus controls for the Main output bus on the LCD monitor, while all the adjacent channel control buttons and knobs are dedicated to controlling the busing parameters as displayed. The secondary U1 function is not implemented in this version of the software.</td>
</tr>
<tr>
<td>PLUG/U2:</td>
<td>Use this button to show active plug-ins on the LCD monitor and allocate controls for the plug-in parameters to the corresponding channel controls. The Plug function as well as the secondary U2 function are not implemented in this version of the software.</td>
</tr>
<tr>
<td>CHAN/U3:</td>
<td>To change the channel controls display mode to Channel mode, use this button. Once in Channel mode the channel control buttons and knobs control the parameters for a single channel. Use Control + CHAN to get to the channel’s Aux Sends. If multiple channels are selected, you’ll see parameters for the last track selected or called. In this version of the software, the secondary U3 function is not implemented.</td>
</tr>
<tr>
<td>ENAB/COPY:</td>
<td>To quickly enable parameters for automation, you can hold this button and touch any channel control button, knob, or fader. The alternative function, COPY, is used to copy parameters between channels by simply touching the control knob or fader where you’d like to copy the specific parameter values. At the time of this writing, these functions are not yet implemented.</td>
</tr>
<tr>
<td>CURVE:</td>
<td>When you want to display a parameter’s automation curves on the active track in the Timeline, hold this button and touch any channel control or the fader, mute, or pan pot on the Channel Fader panel.</td>
</tr>
</tbody>
</table>
### Key Description

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="SPLL" /></td>
<td><strong>SPLL:</strong> SPLL is not used in this version of the software.</td>
</tr>
<tr>
<td><img src="image" alt="ALT" /></td>
<td><strong>ALT:</strong> To access additional display button options or alternate parameter controls on any channel control, use this modifier button.</td>
</tr>
</tbody>
</table>

**Right side of panel, In-Line Channel display buttons from top to bottom:**

<p>| <img src="image" alt="EQ/FILT" /> | <strong>EQ/FILT:</strong> To control the In-Line channel parametric Equalizer (EQ), use this button without a modifier to display four frequency bands, including High Frequencies (HF), High-Middle Frequencies (HMF), Low-Middle Frequencies (LMF), and Low Frequencies (LF). Press the ALT button for Gain control of each of the four bands. Use the Control key for the secondary button function to display and modify the two channel filters for High-pass, Low-pass, High-shelf or Low-shelf filtering. While in EQ/FILT In-Line display mode, the Channel Control touch-sensitive knobs are used to sweep Frequencies or Gain, and the Channel Control buttons toggle between Bell, Notch, High Pass Filter (HPF), Low Pass Filter (LPF), High Shelf (Hi-Sh), and Low Shelf (Lo-Sh) filtering curves. The functionality of EQ/FILT works the same as using the Channel EQ window available on the Fairlight page Mixer. |
| <img src="image" alt="CTL" /> | <strong>CTL:</strong> Use this button to select the secondary functions for the dual-function display buttons below. Also, holding the Control button while touching one of the knobs or faders will reset any of the touch-sensitive controls to their default values. This is one of three identical Control buttons on the channel control components set, and it works the same as pressing the Control modifier key on a computer keyboard. |
| <img src="image" alt="PAN/PATH" /> | <strong>PAN/PATH:</strong> This button displays all the in-line surround panning controls including Left/Right, Front/Back, Down/Up, and Spread. Press the ALT display button to see the alternate Rotate, Tilt, Divergence, and LFE controls. Hold the Control button and press the PAN/PATH button to display the Path setting controls, including Record level, Trim, Insert, and Direct Out. Press ALT while the PATH controls are active to see the alternate Path controls: Mic Gain, Group, and the Direct Output Pre/Post fader switch. These Path settings are the same as the controls in the Path Settings window available via the Track Input drop-down menu on the Fairlight page Mixer. |</p>
<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AUX/AUX</strong>: This button displays in-line controls for Aux sends 1 to 16 in sequential groups of 4 Aux buses at a time. You can toggle between Aux 1-4 and 5-8 by pressing the Aux key. Hold Control while this button is active to display controls for Aux sends 9 to 16. Pressing the Aux key while holding Control will toggle between Aux 9-12 or 13-16. Press the ALT button for the alternate Pre/Post fader controls for the Aux send.</td>
<td></td>
</tr>
<tr>
<td><strong>COMP/U1</strong>: This is for In-Line Dynamics controls for the Compressor, including: Threshold, Attack, Hold, and Release. Use this button without a modifier. Press the ALT button for the alternate Ratio controls. Hold Control and press any of the dynamics display buttons: COMP, LIM, or EXP to access the Makeup gain controls. The secondary U1 function is not implemented in this version of the software.</td>
<td></td>
</tr>
<tr>
<td><strong>LIM/U2</strong>: To display the In-Line Limiter controls, use this button. Without a modifier, you’ll see the limiter controls, including Threshold, Attack, Hold, and Release. Hold Control and press LIM to access the Makeup gain controls. The secondary U2 function is not implemented in this version of the software.</td>
<td></td>
</tr>
<tr>
<td><strong>EXP/U3</strong>: This display button is for the in-line Expander/Gate controls. The unmodified Expander controls include Threshold, Attack, Hold, and Release. Press the ALT button to switch to the alternate Gate controls, including Ratio, Range, Hold, and Release. Hold Control and press EXP/U3 to access the Makeup gain controls. The secondary U3 feature is not implemented in this version of the software.</td>
<td></td>
</tr>
<tr>
<td><strong>ALT</strong>: This is the alternate option modifier button and functions the same as the ALT/Option key on the computer keyboard. To access additional display button options or an alternate control on any channel control, use this button.</td>
<td></td>
</tr>
</tbody>
</table>

The left-side Channel Display buttons without modifiers and with Control button pressed to show secondary functions.
**NOTE:** Non-functioning Channel Display buttons, such as PLUG and ENAB, remain unlit. These buttons will be operational in future software updates.
Channel Control Buttons and Channel Control Knobs

Spanning the middle of the Channel Control panel, you’ll find 12 parallel groups of multi functional channel controls that align with the 12 faders on the Channel Fader panel. Within each of the 12 groups are four highly visible LED buttons and four touch-sensitive rotary knobs. If you touch knobs with Control held this will reset the value, and if you turn a knob with Shift held you will have fine control for the parameter.

Since the functions of these buttons and knobs change based on the channel display mode and selected channel and active parameters, these “soft” controls remain unlabeled, and are identified by the corresponding controls on an adjacent LCD monitor. Additionally, each channel control button is illuminated with bi-colored LEDs to make it easy to identify active buttons, parameters, and groups of controls at a glance.
Channel Control buttons appear red or green when they are matched to a parameter on the Channel LCD monitor, and can be used as either toggles, On/Off, or In/Out switches for the adjacent parameter on-screen. Similar parameters will all have the same colored buttons while the Channel Controls are set to In-Line mode. However, in Channel or Master display mode, you’ll see alternating rows or groups of red or green buttons to separate the different parameter groups as shown on the Channel display.
Additionally, Channel Control buttons brighten to show that they have been pressed, or remain unlit and therefore without color when there is no corresponding parameter with a switch in the current channel display mode.

### In-Line Channel Extension Buttons

Along the bottom of the Channel Control panel are 12 groups of six In-Line Channel Control Extension buttons that match the buttons at the bottom of the Channel LCD Monitor. These dedicated LED buttons are toggle switches for channel-specific controls like Insert, Select, Solo Safe, and Arm. In-Line Channel Control Extension buttons are always available, regardless of the channel control mode, and correspond with similar functions in the Mixer or Timeline track headers on the Fairlight page.

#### In-Line Channel Extension buttons, clockwise from the top left:

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Insert" /></td>
<td><strong>Insert</strong>: Insert In enables routing of up to six VST plug-ins or one hardware effect per channel from Blackmagic Design’s Fairlight audio interface hardware to outboard effects boxes and back again. This button can be toggled to enable/disable insert routing.</td>
</tr>
<tr>
<td><img src="image" alt="Safe" /></td>
<td><strong>Safe</strong>: This button toggles on Solo Safe mode the same as Command-Option-clicking a Solo button on the Fairlight page. Tracks set to Solo Safe will always play, even if Solo is enabled for other tracks, and are easily identified by the blue-highlighted Solo button.</td>
</tr>
<tr>
<td><img src="image" alt="Rec" /></td>
<td><strong>Rec</strong>: Arms the track for recording. This is the same as clicking the Arm button [R] on the corresponding Timeline track header or Mixer channel strip on the Fairlight page Timeline. Tracks must be patched to a microphone or another source input prior to arming.</td>
</tr>
<tr>
<td>Key</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Comp</td>
<td><strong>Comp</strong>: Toggles on or off the channel compression.</td>
</tr>
<tr>
<td>Eq</td>
<td><strong>Eq</strong>: Toggles on or off channel EQ.</td>
</tr>
<tr>
<td>Select</td>
<td><strong>Select</strong>: This button selects a channel in the Fairlight Console Channel Control bay and is the same as clicking a Timeline track header or channel strip in the Mixer on the Fairlight page. You can select multiple tracks by pressing additional Channel Select buttons.</td>
</tr>
</tbody>
</table>

**NOTE**: You can only have a Channel Control panel for a bay that also has the Channel fader and Channel LCD monitor.

**Fairlight Console Channel Fader**

In addition to 12 Channel strips complete with designated control buttons, touch-sensitive faders, and pan knobs, the Fairlight Console Channel Fader panel includes an LCD display of channel information and eight display buttons for bank selection and mapping of up to 144 tracks and buses to the 12 faders. The Fairlight Console Channel Fader panel works in tandem with DaVinci Resolve and the Fairlight Channel Control module for completing professional audio post-production work flows using traditional mixing controls.
LCD Fader Channel Display
At the top of each channel strip you’ll find a high-resolution color display that shows the track name, track color, level, and pan status. If the channel is part of a VCA group, the VCA group number appears above the meters. The information displayed for each track directly correlates with the Fairlight page Mixer and track headers.

LCD Fader Channel Displays showing track name, number, color, pan status, level meters, and VCA group number.

Rotary Knob
Below the LCD display on each channel strip you’ll find the touch-sensitive rotary knob designated as the panoramic potentiometer, or pan pot for short. This versatile dial control is assigned to Left-Right track panning by default, but may also be assigned to other parameters. Press the Control button while you press and release the 2/FDR button to use the rotary knob to control the last-used alternate parameter. This is especially usefully during automation or complex mixing procedures when you need to keep alternative parameters, like the Ratio for your Compressor, within easy reach of the faders. Like all touch-sensitive controls on the Fairlight console components, holding the Control button and touching the knob resets the parameter to the default value, and if you turn the knob with Shift held you’ll have fine control.

Fader Channel Control Buttons
Each channel strip includes four dedicated control buttons for common channel-specific mixing functions. These brightly colored LED buttons are easy to read, logically placed above each fader, and can be used independently or in combination with other channels.
Use this button to select only this channel for playback. Multiple tracks can be soloed simultaneously to isolate selective tracks for playback while all non-soloed tracks will be muted. Pressing Solo while holding the Control button clears all soloed track buttons, and pressing Control again restores soloed tracks. Solo buttons on the Channel Fader panel correspond with the Solo buttons on the Fairlight page Mixer and track headers.

This button turns the channel off and on for playback. Mute buttons on the Channel Fader panel correspond with the Mute buttons on the Fairlight page Mixer and track headers.
CALL: As the name suggests, the Channel Call button simply calls up a track’s parameters in the Channel Control panel and LCD monitor while in Channel display mode. Additionally, the Channel Call button loads the channel into the built-in Audio Editor display, regardless of the channel control mode. Using the Channel Call button is a fast way to work with a channel’s parameters, plus you can quickly press other Call buttons to change focus from track to track for detailed comparison and control. Channel Call on the Fader Panel is similar to the Select button at the bottom of the Channel Control panel; the difference is that the Select button also selects the track in the Fairlight page Timeline and Mixer, which enables additional editing options. Using the Call button while tracks are selected does not change the state of the selected tracks. Call buttons are also used for manually mapping banks of channel faders and spilling the member tracks of a master bus to nearby faders.

Call buttons tally on or off when pressed and change color based on the current task as follows:

- **Yellow Call buttons:** The default color and indicate standard call functionality. When the Call buttons are yellow, only one Call button can be tallied on at a time.

- **Red Call buttons:** Appear when fader mapping is engaged. Auto fader mapping, automatically maps faders to groups of 12 channels in sequential order. When in manual fader mapping mode, you can use the red Call buttons in the Fader panel, or the track selection keys showing in the picture keyboard to manually assign channels to the 12 faders for each fader bank.

- **Green Call buttons:** Indicate master buses and VCA groups in the current fader bank when using the Fader Spill function or isolated fader channels with locked positions when fader lock is active engaged. If fader spill is active, pressing a green Call button spills the member channels of a bus or VCA group to the neighboring faders according to the Fader Spill option keys in the Setup mode layout on the Audio Editor. Call buttons for locked channels also turn green when engaging the fader lock feature that isolates any fader in the current fader bank by holding Control and the 6/LOCK Fader Control Display button and pressing a call button in the active bank.

AUTO: When automation controls are active, the AUTO button arms this channel for automation, preview, write, and trim. Like the Solo and Mute buttons, the Auto button on the Fader Panel corresponds with the Auto buttons on the Fairlight page Mixer and track headers. Automation buttons turn amber when automation is active.

**Touch-Sensitive Faders**

The bottom-half of the Fader Panel comprises 12 touch-sensitive motorized faders that offer precision gain controls for 12 signal paths. These faders correspond with faders on the Fairlight page Mixer, and can be mapped to 12 different fader banks using the Bank Display buttons located on the left side of the Fader Panel. Additionally, each 100mm fader can be assigned to control other channel parameters like send levels, channel trim, or record levels. Holding the Control button while touching a fader resets it to the default position, which is 0 dB.
Fader Bank Display Buttons

On the left side of the Channel Fader module are seven multicolored LED Bank Display buttons that are used to display, map, bus, set, and lock banks of channels to the 12 faders on the panel. The top two buttons are CTL (control) and BANK, which are modifier buttons used to access secondary button functions or additional fader banks for the subsequent numbered Fader Bank Display buttons. Each of the six numbered Fader Bank Display buttons serve three functions, including load a primary fader bank, load an additional fader bank when pressed with the Bank modifier button, or perform a secondary function when the Control button is pressed. You can easily identify the blue Control button at the top of the Fader Bank Display buttons, while the other seven buttons are yellow in their normal state, and blue or purple when the secondary function is selected via the Control button.

With the Fader Bank Display buttons, you can map each of the 12 fader banks with 12 different faders to control a total of 144 tracks and buses to the 12 faders. The more Fairlight Console Channel Fader panels you have in your console, the more faders and tracks you can control. For example, the Fairlight Console 5.bay, is designed for high-end mixing and mastering with four Fader Panels to control up to 576 channels and busses at a time.
Fader Bank Display Buttons from top to bottom:

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CTL</strong>:</td>
<td>This button selects secondary functions for the seven display buttons below and works the same as the Control key on the computer keyboard or the two identical Control display buttons on the Channel Control panel.</td>
</tr>
<tr>
<td><strong>BANK/FLIP</strong>:</td>
<td>You can use the Bank button to switch between the primary fader set for each of the numbered bank buttons labeled 1 to 6, or the additional fader set for the same numbered buttons to show banks 7 to 12. Without a modifier, the Bank button is yellow along with the numbered bank buttons below. When pressed, the yellow Bank button brightens to indicate that it is latched, and the active numbered bank button also brightens to indicate which additional fader set has been loaded. The secondary FLIP function, via the Control button, is used to spill the member tracks of a master bus or VCA group to the neighboring faders.</td>
</tr>
<tr>
<td><strong>1/POT</strong>:</td>
<td>The 1 button chooses Fader Set 1 without a modifier or Fader Set 7 when selected with the Bank button. The alternate POT function for this button has not been implemented.</td>
</tr>
<tr>
<td><strong>2/FDR</strong>:</td>
<td>The 2 button chooses Fader Set 2 without a modifier or Fader Set 8 when selected with the Bank button. Pressing and releasing the 2/FDR button while Control is pressed toggles between normal mode where the fader controls channel level, and secondary mode where the fader controls the last-used alternative parameter.</td>
</tr>
<tr>
<td><strong>3/MAP</strong>:</td>
<td>The 3 button chooses Fader Set 3 without a modifier or Fader Set 9 when selected with the Bank button. If Control is pressed, the 3/MAP button enters the secondary Fader Mapping tool for the current fader set on the Audio Editor.</td>
</tr>
<tr>
<td><strong>4/BUS</strong>:</td>
<td>The 4 button chooses Fader Set 4 without a modifier or Fader Set 10 when selected with the Bank button. Pressing Control along with the 4/BUS button toggles the secondary Bus mode on and off. When Bus mode is on, the system puts all used buses on as many faders as needed to accommodate all non-zero format buses. Pressing a Fader Bank display button from 1 to 6 returns control to the appropriate fader set.</td>
</tr>
</tbody>
</table>
**Key Description**

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5/MSET</td>
<td>The 5 button chooses Fader Set 5 without a modifier or Fader Set 11 when selected with the Bank button. The MSET function has not been implemented.</td>
</tr>
<tr>
<td>6/LOCK</td>
<td>The 6 button chooses Fader Set 6 without a modifier or Fader Set 12 when selected with the Bank button. Hold Control plus the 6/LOCK button to engage the lock setup. When active, you can press the call button for any track or bus fader in the current fader bank to “lock” that fader channel position on the Fader panel. While lock setup is active, call buttons tally green to indicate that channel has an isolated (locked) fader. You can lock/isolate up to 12 faders per fader panel. To unlock faders, hold Control-6/LOCK and unlatch the green call buttons.</td>
</tr>
</tbody>
</table>

**NOTE:** You can temporarily isolate faders from banking by actively touching and holding an individual fader or group of faders while changing fader banks. These “Sticky” faders will be cleared from isolation when the user changes fader banks without holding the fader.

**Manually mapping faders to banks:**

1. In the Fader Bank Display buttons, press CTRL and the 3/Map key to enter fader mapping mode. You’ll know that you entered bank mapping mode because all of the Call buttons turn red. The bank mapping is set to Auto mode by default, which automatically maps channels to faders in sequential order in groups of 12 up to 144. When you enter channel mapping mode, the top four rows of picture keys in the Audio Editor change to track selection keys, while the bottom row of picture keys shows the following dedicated channel mapping function keys:
   - **Exit:** Exits the channel mapping mode.
   - **Delete:** Deletes the channel assigned to the active channel indicated by the tallied red Call button.
   - **Blank:** Leaves a blank fader bank beneath the active red Call button. This is useful for adding a space between groups of similar tracks such as dialogue, background sound effects, and music.
   - **Insert:** As the name suggests, this key inserts an unassigned fader in the position of the active red Call button.

2. In the bottom row of the picture keyboard, press the first key (MODE: Auto/MODE: Manual) to toggle the fader mapping to Manual mode.

3. Press the red Call button on the fader you would like to assign, then choose a channel from the track selection buttons on the adjacent picture keys in the Audio Editor. Once you assign a track or bus to a fader, the next fader to the right becomes active with a red tallied Call button so that you can continue assigning faders sequentially. This automatic call selection also applies to the Delete, Blank, and Insert manual mapping functions.

4. Select up to 12 track selection keys to assign to the current fader bank. Use the Bank display buttons to manually assign additional banks as needed.

5. When you are finished mapping tracks to faders, press the Exit button in the bottom row of picture keys. Once you exit manual mapping mode, the picture keyboard layout returns to the current mode.
Example of Fader Bank 1 in Auto Mapping Mode

Fader Bank 1 in Auto mapping mode showing sequential tracks 1-12 with red Call buttons to indicate bank mapping mode is engaged and the first fader channel’s Call button is active.

Picture keyboard in Auto Fader Bank mapping mode
Auto Fader Bank mapping action keys in the lower left corner of the picture keyboard

Example of Fader Bank 1 in Manual Mapping Mode

Fader Bank 1 in Manual mapping mode showing the custom mapping: A21, blank, A30, A40, and DIALOG to the first five tracks

Fader Bank 1 in Manual mapping mode showing custom mapping: A21, blank, A30, A40, and DIALOG mapped to the first five faders; red Call buttons indicate bank mapping is engaged, with the first fader’s Call button active
Spilling bus member tracks to nearby faders:

1. In the Fader Bank Display buttons, select a fader bank that contains at least one bus. Buses include main, submix, Aux buses, and VCA groups.

2. Momentarily press and hold the Bank/Flip key to change the yellow Call buttons to green Call buttons on the bus fader channels.

3. Press the green Call button for the bus fader you wish to spill to the neighboring faders. Once spilled, the Bank/Flip button turns purple to indicate that the current fader bank is displaying spilled faders for the active bus.

4. To modify the fader spill direction or type of fader that is temporarily remapped, use the Fader Spill options keys available in the Setup mode picture key toolset.

Fader Spill option keys include:

- **Fader Spill**: Use this menu key to reveal two menu Spill option keys that determine the type of fader channel and direction in which member tracks are temporarily mapped to the adjoining faders on the Fairlight Channel Fader panel.

- **Spill Left/Spill Right**: This menu options key toggles between Spill:Left and Spill:Right, which in turn dictates whether the member tracks of a bus are assigned to neighboring faders to the left or right of a bus when Spill is engaged in the Channel Fader panel.

- **Spill Any/Spill Tracks**: When in the default (unlatched) state the Spill:Any menu option allows member tracks of a bus to be spilled to the nearest faders to the left or right, including faders assigned to Master buses and VCA groups. When latched to the Spill:Tracks option, member tracks of a bus spill either left or right starting with the nearest track fader in the designated direction. This option is useful if you need to maintain fader control of your buses while you spill their constituent tracks to the nearest track faders.
Fader Spill and Fader Spill option keys available in Setup Mode toolset on the Audio Editor Picture keys.

Fader Bank 5 with Main 1, Sub 1, and Sub 2 buses assigned to the last three faders; yellow Call buttons indicate standard channel bank display.

Bank/Flip Bank Display Button momentarily held to display the buses within the active track; these buses (in the right 3 channels) can be easily identified by the green Call buttons.
Channel LCD displays Sub 2 bus, including A8, A10, A11, and A12, spilled on the nearest tracks to the left of the Sub 2 bus.

Purple Bank/Flip button indicates there is a spilled bus in the current bank. In this case, Bank 5 is showing, with Sub 2 spilled to the left of the other buses, and includes A8, A10, A11, and A12 as the member tracks that comprise Sub 2.

NOTE: While a bus fader is spilled, you may still use the standard bank display buttons to display any of the other banks normally.

To un-spill a bus fader:
1. In the Fader Bank Display buttons, press the Bank button that contains the spilled bus.
2. Momentarily hold the Bank/Flip button to reveal green Call buttons for the bus faders. The spilled fader’s green Call button will be tallied on.
3. Press the active green Call button to un-spill the fader.

NOTE: You can only spill bus member tracks to faders within the same fader bank. Use the Fader Spill option keys in the Audio Editor Setup mode toolset to spill either left or right within the current bank of 12 faders. Additionally, if you press the Bank/Flip button on a bank without any bus faders, you will not see any green Call buttons or subsequent bus faders to spill.
Sub 2 bus with active (tallied) green Call button, which indicates it has been spilled to neighboring faders

**Fairlight LCD Monitors**

Standard Fairlight consoles include one high-resolution 1920 x 1080 Fairlight LCD Monitor for each bay. These custom designed LCD monitors align perfectly along the top of the console, forming an embedded eye-level monitor bridge that spans the width of the console.

Each Fairlight LCD Monitor is paired with either Channel Control modules as a dedicated channel control display, or the Audio Editing module as a dedicated DaVinci Resolve GUI edit screen. Additionally, the switchable HDMI and SDI inputs on the back of each screen allow flexible display of plug-ins and reference video.
Fairlight Console Configurations

The Fairlight console can be purchased with all the standard panels as a bundle, or customized to meet specialized production requirements. With the Fairlight console’s unique modular design, you always get the flexibility to place the Audio Editor, Infill module, and Channel Component sets, in whichever order works best for you.

Each bundled console includes a console chassis ranging in size from 2-bay to 5-bay, an LCD Monitor component for each bay, one Fairlight Audio Editor, and a set of Fairlight Channel bay components for each additional bay. For custom configurations, you choose the chassis size, and then purchase the console components individually.

Before purchasing a console, it is important to consider the size of your workspace as well as your current and future audio post-production needs. For example, if you have a mid-sized mixing stage and are primarily working on short-form projects like commercials and trailers, a standard Fairlight Console 3-bay may work well. However, if you have the room, a customized Fairlight Console 4-bay chassis may work better in the long run because you’ll also have room to grow in the future for larger feature-length productions. Plus, empty console bays can be filled with custom machined Fairlight Console Blanks that add valuable flat surface space for assistant audio editors and mixers.

Additionally, you can add a Fairlight Console LCD Monitor in the 4th bay to display video playback or plug-ins, and even add a Fairlight Channel Rack Kit to the channel section to mount standard 19-inch equipment such as the Fairlight Audio Interface or Blackmagic Design Smart View duo to your bay.
NOTE: For more information about the Fairlight Console Chassis, bundles, and hardware options, go to the Fairlight Console page on the Blackmagic Design website. [https://www.blackmagicdesign.com/products/davinciresolve/](https://www.blackmagicdesign.com/products/davinciresolve/)

Additional Fairlight Hardware

To effectively connect to and operate a Fairlight console with DaVinci Resolve Studio, you’ll also need a supported audio interface and PCIe audio card. If you are using a Mac or PC without a PCIe slot, you’ll also need an expansion box to connect the PCIe card to your computer, and a supported audio interface. You can use 3rd-party devices or purchase the Fairlight products designed specifically for the Fairlight consoles, including, the Fairlight PCIe Audio Accelerator, Fairlight Audio Interface and the Fairlight PCIe MADI Upgrade.
Performing Firmware Updates

Some DaVinci Resolve updates, such as 17.2.1, require firmware updates to implement the improvements to the Fairlight panels. Users can update all of their Fairlight Console panels in a matter of minutes via the DaVinci Control Panels Setup utility.

Updating firmware on a 2-bay modular console:

1. Quit DaVinci Resolve, if necessary.
2. Open the DaVinci Control Panels Setup utility.
3. In the DaVinci Control Panels Setup Utility, select a panel.
4 Click the circled icon below the panel name.

NOTE: If you are working with the Fairlight Desktop Console or Desktop Fairlight Audio Editor there will only be one panel from which to choose.

5 If there is a firmware update available, you will see an update dialog.

6 Click Update to install the updated firmware on that panel.

7 Once the update is complete, click Done.

8 Repeat this firmware update process for each control panel connected to your system.

9 When all of your panels are updated, close the DaVinci Control Panels Setup.

10 Open DaVinci Resolve.

NOTE: To use DaVinci Control Panels Setup utility for the first time, you need to perform a custom install of the latest version of DaVinci Resolve, and in the custom settings, check the option to install the DaVinci Control Panels utility. Once installed, you can select any panel connected to your system and perform network setup and firmware updates.
Deliver
Chapter 184

Delivery Effects Processing

This chapter discusses how different video effects will be handled when you use the controls of the Deliver page.

Contents

Delivery Effects Processing 3488
When Rendering a Single Clip or When Outputting to Tape 3488
When Rendering Individual Source Clips for Round-Trip Workflows 3488
More About Rendering Speed Effects 3489
Determining the Rendered Output Resolution of Clips in Mixed Timelines 3489
Rendering Edit and Input Sizing Adjustments 3489
Rendering Mixed Frame Rate Timelines 3490
Export Alpha Channels in Individual Clips Mode 3490
Export Alpha Channels in Single Clip Mode 3491
Delivery Effects Processing

For your final output, how effects are rendered depends on whether you’re rendering in Single Clip or Individual Clips mode.

When Rendering a Single Clip or When Outputting to Tape

Whether you’re rendering a QuickTime or MXF master of your project as a single clip, rendering a DPX image sequence for film output, or outputting directly to tape, all supported compositing, speed, and transform effects are rendered by DaVinci Resolve and “baked” into the output media. Unsupported effects are completely ignored, cannot be seen, and have no effect on media that’s rendered and output.

When Rendering Individual Source Clips for Round-Trip Workflows

In workflows where you’re rendering individual media files to send a project back to an NLE or finishing application for final finishing (adding titles and other effects before final delivery), DaVinci Resolve handles different types of effects in different ways.

Unsupported effects do not appear in DaVinci Resolve. However, this effects data is internally preserved, and when you export an XML or AAF file to send back to your NLE of choice, these effects reappear, applied to the color corrected media that you rendered out of DaVinci Resolve and sent back.

Effects that DaVinci Resolve does support such as composite modes, opacity settings, speed effects, and transitions are handled differently. Even though these effects are visible in DaVinci Resolve while you work, they’re not “baked” into the final media that you render in preparation for sending back to your NLE or finishing application. Instead, the portion of each media clip that’s used in your project is rendered as an individual file, and the XML file that you export from DaVinci Resolve contains all of the effects information necessary to reassemble the rendered media into a timeline that uses Final Cut Pro effects applied to DaVinci Resolve-graded media.

<table>
<thead>
<tr>
<th>Effect</th>
<th>EDL</th>
<th>FCP 7</th>
<th>FCP X</th>
<th>Premiere Pro</th>
<th>Media Composer*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color Corrections</td>
<td>N/A</td>
<td>N/A</td>
<td>Rendered</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Composite Modes</td>
<td>N/A</td>
<td>Sent Back</td>
<td>Sent Back</td>
<td>Sent Back</td>
<td>Rendered</td>
</tr>
<tr>
<td>Alpha Channels</td>
<td>N/A</td>
<td>Optionally Rendered</td>
<td>Optionally Rendered</td>
<td>Optionally Rendered</td>
<td>Optionally Rendered</td>
</tr>
<tr>
<td>Transitions</td>
<td>Sent Back</td>
<td>Sent Back</td>
<td>Sent Back</td>
<td>Sent Back</td>
<td>Sent Back</td>
</tr>
<tr>
<td>Opacity Settings</td>
<td>N/A</td>
<td>Sent Back</td>
<td>Sent Back</td>
<td>Sent Back</td>
<td>Sent Back</td>
</tr>
<tr>
<td>Position, Scale, Rotation</td>
<td>N/A</td>
<td>Conditional</td>
<td>Conditional</td>
<td>Conditional</td>
<td>Conditional</td>
</tr>
<tr>
<td>Linear Speed Effects</td>
<td>Sent Back</td>
<td>Sent Back</td>
<td>Sent Back</td>
<td>Sent Back</td>
<td>Sent Back</td>
</tr>
<tr>
<td>Variable Speed Effects</td>
<td>N/A</td>
<td>Sent Back</td>
<td>Sent Back</td>
<td>Sent Back</td>
<td>Sent Back</td>
</tr>
<tr>
<td>Long Duration Still Images</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Freeze Frames</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>Rendered</td>
<td></td>
</tr>
</tbody>
</table>

* These effects are only sent back in AAF round trips when you’re updating an existing AAF file, rather than generating a new AAF file.

The chart shows which effects are rendered by DaVinci Resolve, and which effects are passed back in different round trip workflows.
After you’ve reimported your project back into your NLE or finishing application, you’re free to readjust these effects while completing your program, without the need to re-render individual clips in DaVinci Resolve.

**IMPORTANT**

One exception to the preservation of media and effects in round-trip workflows is that nested sequences from Final Cut Pro 7 and Media Composer are not compatible with DaVinci Resolve; XML and AAF files containing nested sequences cannot be imported. On the other hand, Final Cut Pro X projects containing compound clips can be imported.

**More About Rendering Speed Effects**

If you’re rendering a project with speed effects, you should be aware that DaVinci Resolve can optionally render speed effects using Optical Flow processing, resulting in high-quality slow motion and fast motion effects delivered straight out of DaVinci Resolve. If you’re satisfied with Optical Flow processing in DaVinci Resolve, there may be no need for you to do a round-trip export if the main reason you were doing so was to send the processing of slow motion clips to another application for rendering, and rendering the Timeline in Single clip mode will “bake” the speed effects in using whatever settings you’ve selected for the project, or for each clip if you’ve selected individual Retime Process settings for different clips.

However, if you want to send unrendered speed effects to another application, rendering your project in Individual source clips mode guarantees that the full range of each original clip of media will be rendered, with the speed effect itself exported within the XML, AAF, or EDL file that’s exported.

**NOTE:** DaVinci Resolve adds three frame handles to clips with speed changes applied to them, and to rendered clips that don’t match the project’s frame rate. This is done to facilitate reconform in NLEs that require handles beyond the actual length of each of these clips.

**Determining the Rendered Output Resolution of Clips in Mixed Timelines**

Ordinarily, rendering individual source clips results in each clip being rendered at either the project resolution or the Resolution drop-down in the Render Settings (which overrides the project resolution), with clips that don’t match the project resolution being resized or not according to the settings you’ve chosen in the Image Scaling panel of the Project Settings.

However, if you’re rendering dailies for projects containing clips with mixed resolutions, you can choose to render each clip at its original resolution by turning on the “Render at source resolution” checkbox in the Video group of controls.

**Rendering Edit and Input Sizing Adjustments**

Whether or not sizing is rendered into your final media depends on the “Disable sizing and blanking” checkbox in the Advanced Settings options of the Render Settings panel. You can disable sizing and blanking either when rendering the current Timeline as a single clip, or when rendering individual clips.

- If “Disable sizing and blanking output” is turned off: Output Blanking, Cut and Edit page sizing adjustments, Color page Input and Output Sizing adjustments, and Image Stabilization are rendered into the final rendered media using the optical-quality sizing algorithms available to DaVinci Resolve. This is best if your sizing adjustments are approved and final, and you want to “bake” sizing adjustments into the final media you’re delivering.
If “Disable sizing and blanking output” is turned on: Output Blanking, Cut and Edit page sizing adjustments, Color page Input and Output Sizing adjustments, and Image Stabilization are not rendered, and each clip will be rendered either at the source resolution if “Render at source resolution” is enabled in individual clips mode, or to the currently specified resolution of the Timeline or project. However, the sizing adjustments you’ve made will be exported as part of the XML or AAF file that you’re exporting. This is best for workflows where the editor wants to continue adjusting sizing after you’ve handed off the graded project relative to the original size of the clips.

Keep in mind that if you want to render Input Sizing adjustments into the media you’re outputting, the “Force sizing to highest quality” checkbox guarantees that DaVinci Resolve will use the highest-quality sizing setting, even if you’ve temporarily chosen a faster-processing option for a slower computer.

**NOTE:** “Disable sizing and blanking output” does not disable any transform operations that happen within the Fusion page, nor does it disable transforms happening as a result of an OpenFX or ResolveFX plug-in applied to one or more clips in the Cut, Edit, or Color pages. All of these effects will continue to be rendered into the final output.

**Rendering Mixed Frame Rate Timelines**

Mixed frame rates are supported by DaVinci Resolve when any option other than none is selected in the “Mixed Frame Rate format” drop-down menu, either in the Conform Options section of the General Options panel of the Project Settings, or in the Import AAF or XML dialog. When you choose the appropriate option that corresponds to the application you’re exchanging projects with (or DaVinci Resolve if you’re working entirely within DaVinci Resolve), then DaVinci Resolve conforms and processes all clips in the Timeline to play at whichever frame rate is selected in the “Timeline frame rate” drop-down menu. For example, 23.98, 29.97, 30, 50, 59.94, and 60 fps clips will all play at 24 fps if that’s what “Timeline frame rate” is set to in the Master Settings panel of the Project Settings.

How clips in mixed frame rate timelines are rendered out depends on whether the Render Settings are set to render Individual source clips or a Single clip.

- **Individual source clips:** All clips are rendered individually at their original frame rate.
- **Single clip:** All clips are converted to the “Timecode calculated at” frame rate and rendered as a single media file. Clips are converted using whatever method is selected in the Retime process drop-down of the Master Settings panel of the Project Settings, or in the individual Retime process setting found in the Video inspector of each clip that overrides the project-wide setting. You can choose Optical Flow processing for the highest quality conversion that’s available in DaVinci Resolve.

**Export Alpha Channels in Individual Clips Mode**

This option only appears if you’re rendering to a media format that supports alpha channels. If your media contains an Alpha Channel, you have the option to turn on the Export Alpha checkbox in the Video panel of the render settings whenever you render individual source clips. When you do so, DaVinci Resolve renders clips with alpha channels in either of two cases:

- Whenever there is an alpha channel embedded in the source media for that clip, the embedded alpha channel will be copied to the rendered version of that clip.
- Whenever a clip’s grade has a key connected to an alpha output, the alpha output will be rendered as an alpha channel for that clip.
In either case, you may only render alpha channels out when you render individual source clips to an RGBA format such as TIFF, OpenEXR, ProRes 4444, ProRes 4444 XQ, or DNxHR 444.

Export Alpha Channels in Single Clip Mode

DaVinci Resolve allows rendering alpha channels in Single Clip mode if the selected codec supports an alpha channel (i.e., ProRes 4444, DNxHR 444, etc.). This lets you apply a single alpha channel to an entire timeline for export, rather than just at the individual clip level.

To Render an Alpha Channel in Single Clip Mode:

2. Select a codec that supports an alpha channel in the Video tab’s Codec and Type selection boxes.
3. Select the checkbox “Export Alpha” that appears under the Frame rate selector.
4. If supported by the codec, you can choose the Alpha Mode type. Premultiplied is the default.

If the codec you have selected does not support an alpha channel, the “Export Alpha” box will not appear as an option.
Once you’ve finished grading your project, you need to either render it, or output it to tape to deliver it to your client. This is where the Quick Export window and Deliver page comes in. This chapter describes how to use Quick Export, how to use the overall interface of the Deliver page, and provides some general information about how effects are output from DaVinci Resolve in different situations.

Contents

Using Quick Export 3493
The Deliver Page 3494
The Interface Toolbar 3494
Rendering Files vs. Outputting to Tape 3495
The Render Settings 3495
The Deliver Page Timeline 3496
Filtering the Thumbnail Timeline 3496
The Viewer 3497
Disabling Viewer Updates While Rendering 3497
The Render Queue 3497
Using Quick Export

Not every situation requires a complicated delivery setup. When you just need to quickly export a project, and the full power of the Deliver page is unneeded, you can choose File > Quick Export to use one of a variety of export presets to export your program from any page of DaVinci Resolve. You can even use Quick Export to export and upload your program to one of the supported video sharing services, including YouTube, Vimeo, and Frame.io. You can also add your own presets to the Quick Export window.

To use Quick Export:

1. (Optional) In the Cut, Edit, Fusion, or Color page, set In and Out points in the Timeline to choose a range of the current program to export. If no timeline In or Out points have been set, the entire timeline will be exported.

2. Choose File > Quick Export.

3. Select a preset to use from the top row of icons in the Quick Export dialog, and click Export.

4. Choose a directory location and enter a file name using the export dialog, then click Save. A progress bar dialog appears to let you know how long the export will take.

To customize Quick Export:

1. Open the Deliver page.

2. Create the preset you want to add using the Render Settings panel.

3. Click the Render Settings panel's Option menu and choose the preset or presets you want to add from the Quick Exports submenu so that they're checked. You can also remove your own presets from the Quick Export window by unchecking them in this menu.
The Deliver Page

The Deliver page is divided into five areas of functionality, each of which lets you set up a different part of a render or output to tape.

The Interface Toolbar

At the very top of the Deliver page is a toolbar with buttons that let you show and hide different parts of the user interface. These buttons are as follows, from left to right:

- Delivery full/half height button: Lets you set the Render Settings panel to take up the full height of your display, if you need more area for browsing the various render settings, at the expense of a narrower Timeline.
- Render Settings: This panel lists all of the render settings that are available for configuring rendering jobs in DaVinci Resolve. By default, you’re presented with a short list, but more options are available by clicking “Advanced Settings.”
- Tape: Puts the Deliver page into Tape Output mode.
- Clips: Hides or shows the Thumbnail timeline above the Deliver page timeline
- Render Queue: A list of all jobs that you’ve set up to render in the current project. Previously rendered jobs remain in the queue, for your reference or for you to reuse to re-render those jobs, unless you manually delete them from the queue.
- Render Queue full/half height button: Lets you set the Render Queue to take up the full height of your display, if you need more area for listing render jobs at the expense of a narrower Timeline.
Rendering Files vs. Outputting to Tape

Because the Deliver page does double duty, you control whether you’re rendering files or outputting to tape using the Tape button in the Interface toolbar. Doing so replaces the controls in the Viewer with tape controls.

The Render Settings

The Render Settings contains the customizable settings that determine how media is rendered out of DaVinci Resolve. If you’re using the Tape option, these settings are disabled.

The Render Settings are divided into four general sections:

- **Render Presets:** At the very top, a scrollable row of icons lets you choose one of a series of presets to quickly set up the type of render you want. The Custom option exposes all render settings so you can set up a render manually.

- **Render Location:** A Browse button opens a dialog that lets you choose a volume and directory to render to.

- **Render:** Two options let you either render the entire selected area of the Timeline as a single clip suitable for reviewing or mastering, or as a series of individual clips more suited to round-trip workflows. The option you choose here changes which render settings are available below.

- **Video, Audio, and File Render Settings Panels:** All other render settings are divided among three panels. Checkboxes at the top of the Video and Audio panels let you selectively disable video export (if you want to export the audio only) or disable audio export (if you want to export video only).

For more information on all of these settings, see Chapter 186, “Rendering Media.”
The Deliver Page Timeline

You’ll use the Timeline in the Deliver page to define the range of clips you want to render or output to tape, and to choose which versions for each clip you want to output. The Deliver page Timeline consists of a Thumbnail timeline at top (that can be shown or hidden via the Clips button) that makes it easy to select individual clips or ranges of clips that you need to render, and a more ordinary timeline below that you can use to set In and Out points for rendering arbitrary regions of your program. A Timeline toolbar lets you choose the render range of the Timeline, and has controls for customizing the look of the Timeline, and for zooming in and out.

![The Deliver page's Timeline and Thumbnail timeline](image)

**TIP:** Press Shift-Z to fit the entire program into the available width of the Timeline.

Filtering the Thumbnail Timeline

The Deliver page Thumbnail timeline also has the Timeline Filter drop-down, available to the right of the Clips button in the Interface toolbar.

![The Deliver page's Thumbnail timeline matches the Color page](image)

Using this drop-down to filter the contents of the Timeline lets you restrict the range of media you want to output in different ways. For example, if you’ve already rendered a timeline, but you’ve since made some changes, you can use one of the “Modified Clips” options to display only the clips that have changed within a particular timeframe. Another commonly used option is to choose “Unrendered Clips” to isolate all clips that have not yet been rendered in workflows where you’re only rendering a part of the Timeline at a time.

When you filter the Thumbnail timeline, you can only set up jobs to render in Individual Clips mode. You can tell if Thumbnail filtering is enabled by an orange underline under the Clips button in the UI toolbar.

![An orange line under the Clips button shows that filtering is enabled](image)
The Viewer

When rendering file-based media, the Viewer shows you exactly how the media being output will look using the current settings, and the transport controls move the playhead throughout the current Timeline.

When outputting to tape, the Viewer shows you the tape output so you can set up insert or assembly edit points, and the transport controls move the tape in the deck if device control is enabled. You can also put the Viewer into Cinema Viewer mode by choosing Workspace > Viewer Mode > Cinema Viewer (P), so that it fills the entire screen. This command toggles Cinema Viewer mode on and off.

Disabling Viewer Updates While Rendering

An Updates During Renders submenu in the Render page Viewer option menu lets you choose to disable, minimize, or enable Viewer updates while a program is being rendered. Disabled or minimized Viewer updates will speed rendering, especially on slower workstations.

The Render Queue

The Render Queue is a list of all the jobs you’ve queued up for delivery. Each job can have an individualized range of clips and render settings, which you can use to render multiple sections or clips of a timeline, the same timeline output to multiple formats, or multiple timelines.
The Render Queue displays all jobs.

The Render Queue also has the option to show either just the jobs within the current project, or jobs queued up and saved within all projects in the currently open SQL database (for the current user) or disk database (at the currently selected disk location). This can be exceptionally useful in situations where you've broken a program into multiple reels, with each reel being a different project. This can be turned on and off via the “Show All Projects” option of the Render Queue Option menu.

Jobs in the Render Queue can be edited (by clicking the pencil button), they can be assigned to remote rendering workstations, and they can be deleted. Jobs that have already been rendered can be kept in the Render Queue and re-rendered at a later time.

**TIP:** There is an option to show the Render Settings of each item in the Render Queue, by selecting “Show Job Details” in the Render Queue Option menu. This provides specific details of each job's dimensions, frame rate, codec etc. This is a great help in managing a complex render queue at a glance.
This section describes the options that are available for file-based delivery. The workflow is simple; you define the format and other settings that dictate how the media is to be rendered, define a range of clips in the currently selected session, and then add a job containing these settings to the Render Queue.

You can queue up as many different render jobs as you like, each with different formats, output options, and ranges of clips, depending on what you’re trying to accomplish. When you’re ready to render, simply click the Start Render button.

Contents

- Using Presets for Fast Rendering
- Custom
- YouTube, Vimeo, and Twitter Presets
- ProRes Master
- H.264 Master
- H.265 Master
- IMF
- Frame.io
- Final Cut Pro 7 or X XML
- Premiere XML
- Avid AAF
- Pro Tools
- Audio Only
- Creating and Using Your Own Presets
- Choosing a Location to Render
- Single Clip vs. Individual Clips
- Single Clip
- Individual Clips
Using Presets for Fast Rendering

The very top of the Render Settings list has a set of presets for many of the most common rendering workflows you’ll need to accomplish. If you want to create your very own settings, then choose custom. Each preset automatically sets up what you need and locks you out of settings that are not necessary for rendering that type of media.

Custom

When custom is selected, nothing is automatically set, and all conventional media rendering options are available, except for those that are specifically associated with particular presets. You must manually choose the settings and options you need. All Render settings are saved on a per-project basis.

YouTube, Vimeo, and Twitter Presets

These presets let you render media specifically for video sharing services, with the option to upload the rendered files automatically.

YouTube 720p/1080p/2160p

A drop-down menu lets you choose three different resolutions to render to. Selects the appropriate settings for exporting your program as a QuickTime H.264-encoded file suitable for uploading to
Vimeo, YouTube, Twitter, and many other video file sharing services. Renders a single clip, and sets the Video Format to QuickTime, the Codec to H.264, and the Audio Codec to AAC. In addition to providing the option to automatically upload to YouTube, a Description field and Visibility and Category pop-ups let you choose how you want your video to be presented when uploaded.

**Vimeo 720p/1080p/2160p**

A drop-down menu lets you choose three different resolutions to render to. Selects the appropriate settings for exporting your program as a QuickTime H.264-encoded file suitable for uploading to Vimeo, YouTube, Twitter, and many other video file sharing services. Renders a single clip, and sets the Video Format to QuickTime, the Codec to H.264, sets the video data rate to 10,000 Kb/s, the Audio Codec to AAC, and the audio data rate to 320 Kb/s. In addition to providing the option to automatically upload to Vimeo, a Description field lets you enter text to be added to your video when uploaded and adjust the various visibility options that Vimeo offers, including password protection.

**Twitter 720p/1080p**

A drop-down menu lets you choose two different resolutions to render to. Selects the appropriate settings for exporting your program as a QuickTime H.264-encoded file suitable for uploading to Vimeo, YouTube, Twitter, and many other video file sharing services. Renders a single clip, and sets the Video Format to QuickTime, the Codec to H.264, and the Audio Codec to AAC. In addition to providing the option to automatically upload to Twitter, a Description field lets you enter text to be added to your video.

**Setting Up Video Sharing Uploads**

DaVinci Resolve has account integration with YouTube, Vimeo, Twitter, and Frame.io that allows you to render and upload directly to each service. An Internet Accounts panel in the System tab of the DaVinci Resolve Preferences lets you sign into your YouTube, Vimeo, Twitter, and Frame.io accounts, as well as specify a local cache location for media being synced with Frame.io.

For each service you sign into, a floating window presents the interface in which you’ll need to enter your login name and password to enable integration, followed by whatever two-factor identification and other required steps are necessary. Once entered, DaVinci Resolve will sign in to each of these services automatically when DaVinci Resolve opens.

![Internet Accounts panel of the System tab of the DaVinci Resolve Preferences window](image)

**NOTE:** For Frame.io, the local cache location is used to store clips you import into a DaVinci Resolve project from the Frame.io volume in the Media Storage panel of the Media page.
Deliver and Upload to YouTube, Vimeo, and Twitter

When you've configured YouTube, Vimeo, or Twitter access in the Internet Accounts panel of the System Preferences, the YouTube, Vimeo, and Twitter presets both expose an “Upload directly to YouTube/Vimeo/Twitter” checkbox, which lets you choose whether or not to automatically upload the rendered result.

Choose the desired export options, then click the Add to Render Queue button to add this job to the Render Queue as you would with any other export. When that job is rendered, it automatically proceeds to upload to the selected video sharing service, and an upload percentage indicator appears in the job listing to show how far along this upload is. This upload is done in the background, so you can continue working on other things in DaVinci Resolve while the file uploads. If you want to see how long the upload will take on any other page, you can choose Workspace > Background Activity to see the Background Activity window.

IMPORTANT

Once a video has been uploaded, you’ll want to log onto your video sharing account in a web browser to customize whatever general or privacy settings are necessary for this program, since the uploaded file inherits only the default settings for uploaded media, and your video will likely be publicly available immediately after upload.

ProRes Master

For quickly outputting ProRes Master files of a whole program. When selected, defaults to rendering in single clip mode, with the Format set to QuickTime, the Codec set to Apple ProRes, and the Type set to Apple ProRes 422 HQ. Audio defaults to the Codec being Linear PCM and the Bit Depth being 16.

H.264 Master

For outputting H.264 files of a whole program. When selected, defaults to rendering in single clip mode, with the Format set to QuickTime, and the Codec set to H.264. Quality, Encoding Profile, and Entropy Mode are set to Auto, Passes defaults to Single, and Key Frames default to Automatic with Frame Reordering turned on. Audio defaults to the Codec being AAC with the Data Rate set to 320 Kb/s and the Bit Depth set to 16.

H.265 Master

For outputting H.265 files of a whole program. When selected, defaults to rendering in single clip mode, with the Format set to QuickTime, and the Codec set to H.265. Quality is set to Automatic, Encoding Profile is set to Main, and Key Frames default to Automatic with Frame Reordering turned on. Audio defaults to the Codec being AAC with the Data Rate set to 320 Kb/s and the Bit Depth set to 16.
IMF

Available in DaVinci Resolve Studio Only

A drop-down menu to the right of this preset provides options for Generic, 20th Century Fox, and Netflix-qualified presets. This preset is for facilities that deliver IMF files as digital-only deliverables. A Preset Type drop-down lets you choose the appropriate settings to populate the various locked IMF-specific parameters that appear.

Frame.io

A Frame.io preset at the top of the Deliver page’s Render Settings panel lets you render and upload a program for review. All options in the Render Settings panel update to present suitable controls for this process. At the bottom of the Render Settings list, an “Upload directly to Frame.io” checkbox lets you choose whether or not to upload the rendered result. A Description field lets you add a description to be uploaded along with the rendered media.

Choosing the Frame.io preset

When you choose the Frame.io preset, the Location field turns into a Frame.io field, and the Browse button lets you choose a project and folder path to which to upload the exported result.

Choosing a Frame.io account to deliver a program to
When you export to Frame.io, the available choices in the Resolution, Format, Video Codec, and Type drop-down menus are limited to those that are most suitable for Frame.io file sharing. Choose the desired export options, then click the Add to Render Queue button to add this job to the Render Queue as you would with any other export. When that job is rendered, it automatically proceeds to upload to Frame.io, and an upload percentage indicator appears in the job listing to show how far along this upload is. This upload is done in the background, so you can continue working on other things in DaVinci Resolve while the file uploads. If you want to see how long the upload will take on any other page, you can choose Workspace > Background Activity to see the Background Activity window.

For more information about Frame.io integration, see Chapter 12, “Frame.io Integration.”

**Final Cut Pro 7 or X XML**

A drop-down menu attached to this preset lets you choose from two different XML formats to be exported along with the media you’re rendering:

- Selects the appropriate settings for projects that were sent from Final Cut Pro 7 to DaVinci Resolve using XML. This is meant for situations when you’re rendering media intended for a return trip to Final Cut Pro (by exporting an XML file from the Edit page). Renders Individual Clips, the “Codec” setting on macOS, defaults to Apple ProRes 422 (HQ), Output Size defaults to the current Timeline Resolution (as set in the Master Settings panel of the Project Settings), and Use Unique Filenames is turned on.

  When you choose this preset, an XML of the timeline is automatically exported along with the media, with path names that reflect the rendered clips.

- Selects the appropriate settings for projects that were sent from Final Cut Pro X to DaVinci Resolve using XML. This is meant for situations when you’re rendering media intended for a return trip to Final Cut Pro X (by exporting an FCPXML file from the Edit page). Renders Individual Clips, the “Codec” setting on macOS, defaults to Apple ProRes 422 (HQ), Output Size defaults to the current Timeline Resolution (as set in the Master Settings panel of the Project Settings), and Use Unique Filenames is turned on.

  When you choose this preset, an XML of the timeline is automatically exported along with the media, with path names that reflect the rendered clips.

**Premiere XML**

Selects the appropriate settings for projects that were sent from Premiere Pro to DaVinci Resolve using XML. This is meant for situations when you’re rendering media intended for a return trip to Premiere Pro. Renders Individual Clips, the “Codec” setting on macOS defaults to Apple ProRes 422 (HQ), Output Size defaults to the current Timeline Resolution (as set in the Master Settings panel of the Project Settings), and Use Unique Filenames is turned on.

When you choose this preset, an XML of the rendered timeline is automatically exported along with the media, with path names that reflect the rendered clips.

**Avid AAF**

Selects the appropriate settings for projects that were sent from Avid Media Composer or Symphony to DaVinci Resolve using AAF. This setting is NOT for exporting to Pro Tools. This is meant for situations when you’re rendering media intended for a return trip to Media Composer (by exporting an AAF file from the Edit page). The “Codec” setting defaults to DNxHR 444 12 bit, Output Size defaults to the current Timeline Resolution (as set in the Master Settings panel of the Project Settings), and Render Clip with Unique Filename is turned on.

When you choose this preset, an AAF of the timeline is automatically exported along with the media, with path names that reflect the rendered clips.
Pro Tools

As of DaVinci Resolve version 16, Pro Tools export has been dramatically improved. This preset presents the appropriate options for exporting a specifically formatted AAF project file, linked audio files, and a linked reference video file to Pro Tools, or any application capable of importing a Pro Tools formatted AAF file.

When exporting using the Pro Tools preset, you must use the AAF file that’s automatically created and written to the target location, because it’s formatted specially for Pro Tools and it contains path names reflecting the rendered clips. Do not export an AAF using the File > Export AAF/XML command, as this will not provide the correct exchange file for Pro Tools, and it won’t work correctly.

When you use the Pro Tools preset, DaVinci Resolve outputs the following:

1. What you choose in the Codec drop-down menu of the Audio panel dictates whether you export the audio from the Timeline as a collection of files that link to a separate AAF, or an AAF with audio file embedded within as a single deliverable.
   - Choose Linear PCM to export individual files linked to a separate AAF interchange file
   - Choose Embedded in AAF to export an AAF with embedded Broadcast WAV audio files within it as a single deliverable

Whether you export separate files or a single embedded AAF deliverable, each of the audio clips in the current Timeline can be exported as individual mono or multichannel audio files.

The standard mono round trip export from DaVinci Resolve to Pro Tools is the default setting, with the “Render one track per channel” box checked in the Audio tab of the Pro Tools Render Setting. With this option, a 5.1 polyphonic .wav file would be exported as six individual mono .wav files.

If the “Render one track per channel” box is unchecked, DaVinci Resolve will output multichannel polyphonic .wav files instead. If you do this, it’s important to check in advance that Pro Tools supports the particular multi-channel formats you want to export before committing to this workflow.

Each exported file contains every audio channel from the source media, regardless of channels that have been been muted in the audio panel of Clip Attributes. This means no matter how the video editor organized the channels of audio in the Timeline, you’ll always deliver every channel of each audio clip to whomever is doing your audio postproduction.

2. You can also choose to include handles using the “Add X frame handles” option in the Advanced Settings of the Video panel to add extra frames to the beginning and end of each exported audio clip. This will provide needed editing flexibility to whomever is refining your audio.

3. The type of audio file that’s exported is determined by your choice of video format in the Video panel:
   - If you choose the MXF OP-Atom video format, then MXF audio files will be exported.
   - If you choose the QuickTime format, then Broadcast Wave files will be exported.

4. All video in your timeline will be rendered and output as a single reference movie, in the format that’s selected in the Video panel, with all effects and titles baked in. Subtitles can also be burned into the reference movie or exported as a file. If you want to provide a window burn, you can enable visible metadata using the Workspace > Data Burn-In window. If you do not wish to export a reference movie, you can uncheck the Export Video box in the Video panel.

When you output using the Pro Tools preset, an AAF of the audio tracks of the current Timeline is exported that’s formatted for import into Pro Tools, or any other digital audio workstation (DAW) software that’s compatible with the Pro Tools style of AAF import.
– Exported audio files have the file name and timecode of the source media they were extracted from, to enable relinking to the source media in Pro Tools, if necessary. In the case of Video+Audio files that have been synced in DaVinci Resolve, exported audio files are given the timecode and name of the synced audio source file, not that of the video clip.

– Each audio track exports whatever custom name you may have given it, for use by Pro Tools.

– All track and clip volume automation is exported, with all keyframes.

– iXML metadata is also exported, including channel names when available.

**IMPORTANT**

When you export to Pro Tools in the Deliver page, audio effects are neither exported nor baked in, which means that FairlightFX, EQ, Compression, Pitch, and Elastic Wave effects will be ignored. If you are experiencing problems with imported AAF files, check to see if there are audio effects or audio compound clips in the Timeline, and replace any you find with duplicates of the same audio clips that have no effects.

### Audio Only

This preset is specifically for rendering an audio-only media file from the Timeline. Video rendering is disabled, and this preset defaults to rendering the Main 1 bus as a single clip, rendering one track per channel using the MXF OP-Atom format set to the Linear PCM codec, at 16-bits. However, the QuickTime, MP4, and WAVE formats are also available, and you can also render 24- or 32-bit output. Additionally, you have the option to render other Mains or Submixes, or to choose a specific Timeline Track to render. Finally, you can choose to render the current program as Individual Clips.

### Creating and Using Your Own Presets

If there is a particular group of settings that you find yourself using repeatedly, you can turn it into a custom Easy Setup, for easy recall.

**To create a new Easy Setup:**

1. If you want to start from scratch, make sure to choose Custom from the preset panel to unlock every setting in the Render Settings pane.
2. Choose the particular settings you require in the Video, Audio, and File panels for your new preset.
3. Open the Render Settings Options menu, and choose Save as New Preset.
4. Type a name into the “Render Preset” dialog, and click Save. The new preset now appears in the Preset panel.

**To load a preset:**

– Click any preset. Every setting in the Render Settings pane updates to reflect the preset you selected.

**To change a custom preset that you’ve created**

– Click a preset you want to change, make whatever changes you need to in the Video, Audio, and File panels, then click the Render Settings Option menu, and choose Update Current Preset.

**To delete a custom preset that you’ve created:**

– Click a preset you want to delete, then click the Render Settings Option menu, and choose Delete Current Preset.
Choosing a Location to Render

The first decision you have to make when rendering your output is where it's going to be rendered. Accordingly, this is the first set of controls appearing at the top of the Render Settings parameters.

– **Filename:** A preview of what the file name will be based on the settings found in the File panel described later. The Custom/Timeline name and File suffix fields, as well as the “Use x digits in the filename” settings all determine what name appears here. The editable portions of this filename preview can also be edited here.

– **Location:** Click the Browse button to choose a directory in which to write the media being output by DaVinci Resolve. After you've selected a directory, the path name appears in the “Render job to” field.

Single Clip vs. Individual Clips

While there are numerous options available in the Render Settings of the Deliver page, there are basically two overarching ways you can render your project, depending on which of the “Render” radio buttons you click in the Output group.

![Render Options](Render single clip or individual clips)

### Single Clip

When you select the Single clip option, you’re setting up a render wherein all clips in the session are output together, as a single media file in whatever format you choose. This means you'll be rendering the selected range of the session to a single MXF or QuickTime file, or as a single collection of image sequences.

– **Timecode:** The timecode that’s written out is dictated by the “Start timeline timecode at” setting of the timeline being rendered. Media files contain a continuous timecode track, while image sequences have timecode written into each frame's data header, and integrated into the file name (as a frame count).

– **Frame Rate:** If you’re rendering a project that uses mixed frame rates, rendering to a single clip converts every clip in the entire session to the project frame rate, using either the project-wide or clip specific “Retime process” setting.

– **Effects:** Most effects are “baked into” the rendered output when you render a single clip.

**IMPORTANT**

Whenever clip filtering is enabled (via the drop-down menu to the right of the Clips button), Single Clip rendering cannot be selected. You can see if clip filtering is enabled by an orange line underneath the Clips button in the UI toolbar.
Individual Clips

Selecting the Individual clips option sets up a render where each clip is rendered as an individual media file in whichever format you choose. The result will be a collection of as many media files as there are clips in the range you’ve selected to render.

- **Timecode**: The timecode written to each clip is cloned from the original source media, making it easy to reconform media for projects being passed between DaVinci Resolve and NLEs.
- **Frame Rate**: If you’re rendering a project that uses mixed frame rates, rendering to source renders each clip at its own individual frame rate, to accommodate round-trip workflows.

All Other Render Settings for Output

This section covers the different render settings that are available for customizing your output. Depending on which Render Setting mode you chose, some of these may be hidden, but this section covers the full list found in the Advanced panel of controls.

If you choose one of the Easy Setups, then some of these settings will be locked, and others will be editable, depending on the requirements of that setup. If none of the Easy Setups is suitable for the task at hand, you can leave the Easy Setup drop-down menu set to none, and manually choose the necessary settings for the task at hand.

Video Panel

This panel contains all video-oriented parameters.

Format and Codec Controls

These top-level parameters let you choose whether or not to render video, and which format to render it to. Depending on which Format, Codec, and Type you choose, other options may or may not appear.

- **Export Video**: Turn this checkbox on to render the source video. Turn this checkbox off if you want to render the source audio all by itself; this disables all video controls, and shows an Audio Format drop-down menu in the audio section of settings.
- **Format**: A drop-down menu that gives access to the container formats that are currently available on your system. The available options depend on whether you have Final Cut Pro and QuickTime installed, and on the operating system you’re using. This list is constantly growing, as new file formats are added over time, so be sure to check each new version for the latest supported formats.
  - **AVI**: A now-deprecated file-based media format that, despite its age, remains popular with Windows applications. Supports delivery using the Cineform, Grass Valley HQ and HQX, and Uncompressed RGB and YUV codecs.
  - **Cineon**: An older uncompressed image sequence format developed by Kodak, designed for film scanning and digital mastering, which delivers RGB 10-bit.
  - **DCP**: Native DCP encoding and decoding for creating unencoded DCP files only. If you have a license for Frauenhofer’s EasyDCP, a setting in the Configuration panel of the System Preferences enables you to choose whether to use EasyDCP (for creating encrypted DCP output), or the native DaVinci Resolve encoding.
  - **DPX**: An uncompressed image sequence format favored by the film industry for mastering and delivery for DCDM mastering, which can be delivered as RGB 10-, 12-, 16-bit integer and half float, or RGBA 8-bit.
  - **easyDCP**: (when installed) An option that allows you to master a DCP or IMF directly from DaVinci Resolve in conjunction when you have an installed license of Frauenhofer’s EasyDCP software.
- **EXR**: The OpenEXR format is a high-dynamic-range image sequence format developed by ILM for applications requiring high quality and multiple channels. Used for outputting ACES and HDR deliverables. You can deliver to a variety of RGB Half and RGB Float settings. When choosing the RGB half (DWAA) or (DWAB) compression codecs, an additional "Compression level" setting appears that lets you choose how much compression to apply.

- **IMF**: A native IMF encoding option that lets you export to the SMPTE ST.2067 Interoperable Master Format (IMF) for tapeless deliverables to networks and distributors, with support for encoding of JPEG2000 using a library licensed from Kakadu software. No additional licenses or plug-ins are required to output to IMF. The IMF format supports multiple tracks of video, multiple tracks of audio, and multiple subtitle and closed caption tracks, all of which are meant to accommodate multiple output formats and languages from a single deliverable. This is done by wrapping a timeline’s different video and audio tracks (media essences) and subtitle tracks (data essences) into a “composition” within the Material eXchange Format (MXF).

- **JPEG 2000**: DaVinci Resolve 15 introduced support for the encoding and decoding of JPEG2000 using a library licensed from Kakadu software. This includes a complete implementation of the JPEG2000 Part 1 standard, as well as much of Parts 2 and 3. JPEG2000 is commonly used for IMF and DCP workflows.

- **MJ2**: The Motion JPEG 2000 format. DaVinci Resolve 15 introduced support for the encoding and decoding of JPEG2000 using a library licensed from Kakadu software. This includes a complete implementation of the JPEG2000 Part 1 standard, as well as much of Parts 2 and 3. JPEG2000 is commonly used for IMF and DCP workflows.

- **MP4**: Dedicated MP4 encoding lets you export H.264-encoded movies.

- **MXF OP–Atom**: A simple standard for the Material eXchange Format, a file-based media format, that's often used when delivering DNxHD. This version conforms to the SMPTE 390M standard, and can deliver using the DNxHD, DNxHR, Kakadu JPEG 2000, NTSC and PAL Avid, RGB Avid 10-bit, and XDCAM MPEG2 codec options.

- **MXF OP1A**: A version of the Material eXchange Format that conforms to the SMPTE 378M standard, and can deliver using the 1080i Avid 8-bit, DNxHD, DNxHR, Kakadu JPEG 2000, NTSC and PAL Avid, RGB Avid 10-bit, Sony MPEG4 422 and 444, and Sony XAVC Intra CBG and VBR, and XDCAM MPEG2 codec options.

- **QuickTime**: Apple’s file-based media format, used when delivering Apple ProRes, DNxHD or DNxHR wrapped in QuickTime, GoPro Cineform RGB 16-bit and YUV 10-bit, Grass Valley HQ and HQX, Kakadu JPEG 2000, H.264, HEVC, H.264 (single or multi-pass), Photo JPEG, Kakadu JPEG 2000, Uncompressed 8- and 10-bit formats with ARGB/RGBA/RG/B/YUV channel orders, and VP9 at 8-, 10-, and 12-bits.

- **TIFF**: “Tagged Image File Format,” an image sequence format compatible with many desktop video applications on many platforms and is also used when delivering for DCDM mastering.

- **Codec**: A drop-down menu that lets you choose from a selection of codecs that are available to the format you’ve selected above.

- **Type**: Different codec options may also present different bit depth and color space combinations, as well, which are available from this menu.

- **Maximum Bit Rate**: (Does not appear for all codecs) Codecs such as Kakadu JPEG 2000 let you specify a maximum bit rate, in Mbits per second, with which to encode the delivered video.

- **Field rendering**: If you’re processing interlaced source material, this checkbox sets DaVinci Resolve to render each field individually before reintegrating them back into a single frame, in order to process clips most accurately with filtering operations that would otherwise violate field boundaries and cause problems. If you’re not rendering interlaced media, you should leave this checkbox turned off, as it is more processing intensive.
– **Export HDR10 Metadata**: (Available in Single clip mode if HDR10+ is enabled in Project Settings) Exports HDR10 metadata to the rendered file when you’re doing an HDR workflow.

– **Embed HDR10 Metadata**: (Available in Single clip mode if HDR10+ is enabled in Project Settings) Exports HDR10 metadata to the rendered file when you’re doing an HDR workflow. Embeds HDR10 metadata within the exported media of selected formats.

– **Render at Source Resolution**: (When rendering Individual Clips) This checkbox lets you render each clip at the same resolution as its source media file, letting you preserve mixed frame sizes for final delivery.

– **Resolution**: The output resolution for rendering. This setting defaults to the current resolution of the project as set in the Master Settings panel of the Project Settings, modified by whatever transforms are applied in the Sizing palette in Output mode. However you can change the resolution here if you need to output at a different resolution. Using this setting, you can queue up different render jobs at different resolutions, in order to output both HD and SD resolution media in the same render session, for example. Some file formats require specific resolutions, in which case the Output Size settings will be automatically set to the necessary resolution.

– **Frame rate**: (When rendering Single Clip) This setting is typically identical to the “Timecode calculated at” frame rate in the Master Settings panel of the Project Settings. However, you may wish to set this to a variation of the current conformed rate, for example choosing from between 23.98 or 24 fps. Doing so will adjust the metadata written within the file, which is used to aid playback for the range of systems available worldwide.

– **3:2 Pulldown Insertion Options**: Starting with DaVinci Resolve Studio 12.5, you have the option of outputting either 29.97 or 30 fps media with 3:2 pulldown insertion if your project’s playback frame rate is either 23.98 or 24 fps. To output 29.97 media, the project must be 23.98 fps; simply choose (23.976 3:2) from the Frame rate drop-down. Projects with 24 fps frame rates can only be output at 30 fps.

– **Export Alpha**: (When rendering Individual Clips) Turning this checkbox on results in alpha channels found in each clip’s source media file being output to each delivered clip, as well as alpha information that you’re creating in DaVinci Resolve and inserting into that clip via the Alpha output of the Color page Node Editor being output to each delivered clip.

– **Alpha Mode**: (When rendering Individual Clips) Lets you choose how to export alpha channels when Export Alpha is enabled. You can choose Straight or Premultiplied.

– **Render Stereoscopic 3D**: (Only appears if there are stereo clips in a timeline) Three options let you choose how to render stereoscopic timelines, rendering just one eye’s worth of media at a time, or rendering a single set of stereo media in one of four ways, depending on the option you choose from the “Both eyes as” drop-down menu.

  – **Left eye**: Lets you render only the left-eye media from a stereo timeline.
  
  – **Right eye**: Lets you render only the right-eye media from a stereo timeline.
  
  – **Both eyes as**: Lets you select from four ways of rendering the left and right eyes of stereo media as a single set of media files. “Separate files” lets you output both the left-eye and right-eye media as individual media files, all at once. Side-by-side, Line-by-Line, and Top-Bottom let you output frame-compatible media that can be output to stereo-capable displays. Anaglyph lets you output a traditional anaglyph red/cyan stereo image for viewing on any display using red/cyan glasses.

– **Use Constant Bit Rate**: If the Format and Codec you’ve specified allows you to switch between variable and constant bit rate output, this checkbox lets you force video to render at a constant bit rate.
Optional MP4, H.264, H.265, VP9, or HEVC Controls

If you choose MP4 as the format, or QuickTime with H.264 or VP9 as the codec, additional options appear, described below. Workstations using NVidia GPUs that offer NVENC will present alternative accelerated options, while other workstations offering QuickSync hardware encoding instead will be able to use that option.

- **Use hardware acceleration if available**: DaVinci Resolve supports QuickSync hardware encoding of H.264 and HEVC, if available on your workstation.

- **Quality**: If the currently selected option in the Render to drop-down menu has options for changing the compression quality, this drop-down menu lets you choose the quality you want to use. Otherwise, it’s disabled.

- **Restrict to X Kb/s**: (Available for QuickTime H.264) You can choose Automatic, or select a maximum data rate with which to export H.264.

- **Encoding Profile**: A drop-down that lets you choose among different encoding profiles, each of which has been optimized for different purposes. The tradeoff is between quality and computational intensity for encoding and playback. The available options are:
  - **Auto**: Automatically selects an encoding profile.
  - **Base**: For H.264, intended for video conferencing and mobile phone use; highly compressed.
  - **Main**: For H.264, intended for SD analog transmission. For H.265, intended for the compression of 4:2:0 video at up to 4K 60fps with a bit depth of 8-bits per channel.
  - **Main10**: (H.265 only) Intended for the compression of 4:2:0 video at up to 4K 60fps with a bit depth of 10-bits per channel.
  - **High**: For H.264, intended for Blu-Ray and HD transmission.

- **Entropy Mode**: (called Entropy Coding Mode for compatible Nvidia GPUs) A drop-down that lets you choose which algorithm the encoder should use for compression. The choices are:
  - **CALVC (context-adaptive variable-length encoding)**: A lower-quality algorithm that’s less computationally intensive to process and play.
  - **CABAC (context-based adaptive binary arithmetic coding)**: A higher-quality algorithm that yields better visual quality at lower bandwidth, at the cost of being more computationally expensive to process and play.

- **Multi-pass encode**: (Available for QuickTime H.264) You can choose between Single and Multi-pass encoding. Single pass is faster, but multi-pass yields superior results when quality is important. When you enable Multi-pass, the number of passes performed is automatic.

- **Key Frames**: (Available for QuickTime H.264) You can choose Automatic, or select a duration for manual keyframe insertion.

- **Frame Reordering**: (Available for QuickTime H.264) On by default, Frame Reordering enables the encoding of B frames to improve the quality of the resulting compressed movie file. Turning off Frame Reordering will speed encoding performance at the expense of visual quality.

- **Rate Control**: (Available for compatible Nvidia GPUs) Provides six options for controlling Encoding Profile and Entropy Mode.

- **Lookahead**: (Available for compatible Nvidia GPUs) Lets you specify how many frames for the encoder to examine in advance of compression.
Optional DCP and IMF Controls

If you choose DCP or IMF as the Format, additional options appear, described below.

– **Use interop packaging:** (DCP only, located under Type parameter) Lets you create an Interop DCP package, based on an earlier standard of DCP delivery that is not forward compatible with SMPTE DCP packages.

– **Package Type:** (IMF) Defaults to App2 Extended (App2e), for encoding JPEG 2000 up to 4K.

– **Bit Depth:** (IMF) The bit depth of the encoded IMF video.

– **Encoding Profile:** (IMF) A drop-down that lets you choose among Auto, IMF, and Broadcast.

– **Encoding Level:** (IMF) Provides different choices based on what is selected in Encoding Profile.

– **Maximum bit rate:** (DCP, IMF) Lets you choose how much to compress the result.

– **Lossless Compression:** (IMF) Lets you choose to encode using lossless compression.

– **Slope-Rate Control:** (DCP, IMF) A checkbox lets you specify lossless compression.

– **QStep:** (DCP, IMF) Lets you choose either automatic or manually specified DCP quantization levels at which to compress the video signal when using the Kakadu JPEG 2000 encoder.

Advanced Controls

An advanced settings disclosure button hides the following additional controls, by default.

– **Pixel aspect ratio:** Lets you override the Project Settings and change the PAR of the rendered output to either Square or Cinemascope.

– **Data levels:** Defaults to “Auto,” which simply renders all clips with the data level appropriate to the currently selected codec in the “Render to” drop-down menu, which is usually the preferred behavior. Choosing one of the other options (“Video” or “Full”) outputs all clips using the selected data range. For more information, see Chapter 8, “Data Levels, Color Management, and ACES.”

– **Retain sub-black and super-white data:** Turning this checkbox on lets you choose to output media files that preserve overshoots and undershoots, data that’s above the maximum and minimum data levels of the data level you’ve selected, assuming this is supported by the video format and codec you’re exporting to. Otherwise, DaVinci Resolve clips these “out-of-bounds” parts of the signal in an effort to keep your deliverables from violating whatever QC standards you’re adhering to in your grade.

– **Color Space Tag:** A drop-down menu that lets you choose a color space to embed as metadata in the rendered file. This setting defaults to the Output Color Space if your project’s color science is set to DaVinci YRGB Color Managed, or the ACES Output Device Transform if your color science is set to ACEScc or ACEScct.

– **Data burn-in:** A drop-down menu that defaults to “Same as Project,” which leaves the current Data Burn In palette settings enabled while rendering, inserting a window burn into the media being output. Choosing “None” disables window burns while rendering. Note that when rendering as Individual Source Clips, individual clip burn in presets can be assigned if they’ve been created in the Data Burn In palette.

– **Use optimized media:** When this checkbox is turned on, DaVinci Resolve will use optimized media, when available, to do the final render, to save time. If your media has been optimized to the same format as the one you’re outputting to (or better), this is convenient. However, if you’ve optimized to a lower quality format than what you’re outputting to, you should turn this checkbox off to force DaVinci Resolve to process all clips using the original media, guaranteeing the best quality available.
– **Use render cached images:** When this checkbox is turned on, DaVinci Resolve will write media from the cache to the files being output to save time. If you're caching using the same media format you're outputting to (or better), this can be convenient. However, if you're caching in a lower-quality format than the one you're outputting to, you'll want to turn this checkbox off to force DaVinci Resolve to process all media as it's being rendered, writing at the maximum quality you're outputting to.

– **Enable flat pass:** Three options let you choose whether or not to render each clip with its grade applied.
   - **Off:** DaVinci Resolve always applies each clip's grade when rendering.
   - **With clip settings:** For each version of a clip, the system will check that version's pass flat flag. If it's turned on, the system disables color correction for that version of the clip. Otherwise, that version will be rendered with its grade intact. Versions can be individually flagged by right-clicking a clip's thumbnail in the Timeline, choosing the submenu of the version you want to flag, and choosing Enable Flat Pass.
   - **Always On:** When checked, DaVinci Resolve disables the grade of every clip being rendered.

– **Trigger script at:** You now have the option of triggering a script to execute before or after rendering a timeline, by checking the “Trigger script at” box.
   - **Start:** Executes the script before the render job.
   - **End:** Executes the script after the render job.
   - **Script:** Chooses the specific script to run. You can select the specific script to execute using the corresponding drop-down menu. Scripts must be written for the Resolve scripting framework in either Python or Lua, and placed in the following directory:

   MacOS: `/Library/Application Support/Blackmagic Design/DaVinci Resolve/Fusion/Scripts/Deliver/

   Windows: `C:\ProgramData\Blackmagic Design\DaVinci Resolve\Fusion\Scripts\Deliver`

   Linux: `/opt/resolve/Fusion/Scripts/Deliver`

– **Disable sizing and blanking output:** When turned off, Output Blanking to create letterboxing or pillarboxing is “baked” into the output, as are all sizing adjustments made on the Cut, Edit, and Color pages, including Image stabilization.

When turned on, Output Blanking, Cut and Edit page sizing adjustments, Color page Input and Output Sizing, and Image Stabilization are disabled. Rendered media is rendered either at the source resolution if “Render at source resolution” is enabled in individual clips mode, or to the currently specified resolution of the Timeline or project. If you’re outputting via Final Cut Pro or Premiere Pro XML, or Avid AAF; sizing adjustments are output to the XML or AAF files that are created for purposes of round-tripping these adjustments as editable metadata back to an NLE.

Be aware that “Disable sizing and blanking output” does not disable any transform operations that happen within the Fusion page, nor does it disable transforms happening as a result of an Open FX or Resolve FX plugin applied to one or more clips in the Cut, Edit, or Color pages. All of these effects will continue to be rendered into the final output.

– **Force sizing to highest quality:** If you’ve been working with the “When resizing and scaling:” option set to Bilinear to improve performance when working on slower workstations, turning this checkbox on automatically renders all clips using the “Uses Sharper filter” setting of the Image Scaling panel in the Project Settings. For more information, see Chapter 4, “System and User Preferences.”
– **Force debayer res to highest quality:** When rendering camera raw media formats that allow variable quality debayering, it’s common to lower the debayering quality to improve real time performance while grading. Turning this checkbox on guarantees that media will always be rendered at the highest available quality, saving you from forgetting to manually change the debayer setting back when setting up a render at 3am.

– **Add X frame handles:** (When rendering Individual Clips) Lets you specify front and rear handles to be output in frames. This is particularly useful in round trips, when the finishing editor might want additional handles with which to roll edit points or add transitions while fine-tuning the graded edit.

– **Tone Mapping:** (Available in Single clip mode if Dolby Vision or HDR10+ is enabled in Project Settings) When set to None, the timeline is output using the current color management settings. When set to either Dolby Vision or HDR10+, you can choose to output the timeline at a specific peak nit level, color space, gamma, and Data Level using either the Dolby Vision or HDR10+ metadata available to guide the tone mapping operation you’ve selected. This makes it easy to set up multiple jobs to output HDR outputs at varying levels, as necessary.

– **Bypass re-encode when possible:** (Single Clip mode only) Turning this checkbox on makes it possible to do a direct copy of the video essence of video items in the Timeline, directly from the source media to the file being output, when the selected Format, Codec, and Type matches the source. This also preserves alpha channel data for compatible formats.

Bypass re-encode eliminates the need to re-encode video media, preserves quality, and speeds up the output process dramatically, but it only works for clips in the Timeline to which no additional effects have been added. Doing any grading, adding a Resolve FX plug-in, adding any overlapping effects or compositing to clips in the Timeline, resizing or stabilizing clips or altering the output sizing of the Timeline, and adding Fusion effects will all necessitate re-encoding the entire clip in order to process these effects. Transitions will require processing, but only for the duration of each transition.

There are many situations where this is valuable:

– **Fast output of simple edits:** You’ve edited a simple cuts-only promo using footage cut from a previously rendered program using QuickTime ProResHQ 422 media, and you’re exporting to the exact same format. You can output all of the media very quickly using Bypass re-encode when possible.

– **Fast output of previously output timelines with small changes:** You need to replace a few shots in an effects-intensive program that’s already been output. You can import the media file that was output into a new timeline, replace only the required shots with new media. DaVinci Resolve will do a direct copy of all previously rendered media, while re-encoding only the new clips with whatever effects and grading they contain. This lets you quickly re-output a high-quality master file, while preventing you from needing to re-render the entire program.

– **Fast output of previously output timelines with new audio mixes:** You’ve placed a previously rendered Video+Audio clip onto a timeline and edited a new audio mix clip to replace the old audio mix. In this situation, a new Video+Audio file will be quickly written with the new audio, but the video component of that file won’t be re-encoded, again resulting in a fast export at the highest quality.

**TIP:** For a list of which video formats are compatible with Bypass Re-encode on macOS, Windows, and Linux, as well as which formats are compatible with alpha channels, see the “Supported Codec List” at the DaVinci Resolve Support page, located at https://www.blackmagicdesign.com/support/family/davinci-resolve-and-fusion.
DCP and IMF Composition Settings
If you've selected either DCP or IMF from the Format, a Composition Settings group appears with the following parameters when you click the disclosure control, which let you populate standard DCP and IMF composition metadata:

- **Composition name**: The name of the exported composition.
- **Issuer**: The organization providing the composition.
- **Use current date**: A checkbox that lets the current date be used as the Issue date automatically.
- **Issue date**: The date the composition is issued.
- **Content kind**: A drop-down provides a list of acceptable choices for defining the content.
- **Content version label**: Meant to identify the version of the content being provided.
- **Annotate xml using composition name**: Auto-populates Asset Map, Composition Playlist, and Packing List with data from the project. Otherwise these three fields are manually editable.
- **Annotate reel index as suffix (DCP only)**: Auto-populates Reel Annotation with data from the project. Otherwise this is manually editable.
- **Annotate media using filename**: Auto-populates Main Video Track and Audio Track 1 with data from the project. Otherwise these three fields are manually editable.

Subtitle Controls
The Subtitle Settings group exposes controls governing how to export subtitles in your program:

- **Export Subtitle**: This checkbox determines whether or not subtitles will be output or ignored.
- **Format**: Lets you choose how you want subtitles to be output, if present.
  - There are two options:
    - **As a separate file**: Exports all subtitles in the current timeline as a separate file of the format selected in the Export As drop-down.
    - **Burn into video**: Renders the current timeline with all subtitles appearing within the picture. When Burn into video is selected, the Export As drop-down is hidden.
- **Export As**: This drop-down is only adjustable if Format has been set to "As a separate file." The two available formats are SRT and WebVTT.

Audio Panel
This panel contains all audio-oriented parameters.

- **Export audio**: Turn this checkbox on to render the source audio, or audio that you've synchronized in DaVinci Resolve, along with the media being output by DaVinci Resolve.
- **Format**: You can choose which format of audio you want to render. Depending on which format you choose, different audio codec options will appear below.
  - **MXF OP-Atom**: Generates media files that conform to the SMPTE 390M format of MXF media for file exchange.
  - **QuickTime**: Exposes all available formats of audio compatible with QuickTime.
  - **WAVE**: Generates media in the WAVE format.
  - **MP4**: Generates media in the MPEG-4 file format.
Codec: Lets you choose between Linear PCM (the default), AAC audio, and IEEE Float (Wave only). AAC audio encoding is only available on macOS.

Bit Rate Strategy: (Available for AAC encoding) You can choose among Constant Bit Rate, Average Bit Rate, Variable Bit Rate Constrained, and Variable Bit Rate.

Quality: (Available for AAC encoding when Bit Rate Strategy is set to Variable Bit Rate) Five settings you trade between speed and quality when encoding AAC audio.

Data Rate: (Available for AAC encoding when Bit Rate Strategy is set to Constant, Variable, or Variable Constrained) Lets you choose the maximum data rate for AAC encoding.

Bit Depth: Lets you specify the bit depth at which to output the source audio.

Render one track per channel checkbox: This checkbox lets you specify whether you want to export each channel as an individual track in the structure of the exported file.

Output Track #: This drop-down menu lets you choose which Main or Submix bus you want to output. A Plus button to the right lets you add additional tracks you want to export in this job, so if you want to export multiple Mains or multiple Subs, you can add more Track pop-ups.

When you choose a track with multiple channels of audio, a field appears showing how many channels will be output; you have the option of using a virtual slider to change how many channels are output.

In Single Clip Mode, when you choose “All Timeline Tracks, each audio track in the current timeline will be rendered as an individual track in the rendered media file you’re outputting. Multi-channel tracks containing multi-channel clips will output audio tracks containing the same number of channels in the output media, which means you can output mixed combinations of mono, stereo, 5.1 or 7.1, and adaptive audio tracks, and each separately rendered audio track will reflect identical channel mappings.

Language: (Only available when outputting to the IMF format) This drop-down menu lets you choose the language of a particular output track when you’re outputting to IMF. Since IMF files can accommodate multiple audio tracks containing different mixes for different regions, it’s important to identify each output track you’re outputting by language.

Content: (Only available when outputting to the IMF format) This drop-down menu lets you choose the content of a particular output track when you’re outputting to IMF. Since IMF files can accommodate multiple audio tracks containing different mixes and content, it’s important to identify each output track you’re outputting by content.

File
This panel contains all other parameters.

Filename Uses: Three options let you automatically name the media file(s) that are output automatically.

Use Custom Filename: Lets you enter your own name in the Custom name/File prefix field.

Use Timeline Name: (When rendering a Single Clip) When this option is selected, the name of the Timeline is used.

Use Source Filename: (When rendering Individual Clips) When this option is selected, the filename of each clip’s corresponding source media file is cloned, and used as the filename of media being output by DaVinci Resolve. This is preferred when you’re generating offline media for use by an editor that you later want to reconform to the originating DaVinci Resolve project. When this checkbox is turned off, you can customize filenames using the other options in this section of settings.
– **Custom name:** Lets you use custom text to name all rendered files. If you’re not using the source filename, and not rendering to a file format that uses timecode, you can enter a filename here. When editing the Custom Name or File Prefix (or File Suffix), you can use “metadata variables” that you can add as graphical tags that let you display clip metadata. This is especially useful when rendering individual Source Clips. For example, you could add the corresponding metadata variable tags `%scene_%shot_%take` and the File Prefix would be written as “12_A_3” if “scene 12,” “shot A,” “take 3” were in the source clip’s metadata. For more information on the use of variables, as well as a list of all variables that are available in DaVinci Resolve, see Chapter 15 “Using Variables and Keywords.”

– **File suffix:** Lets you add custom text and/or metadata variables (described previously) to the end of all rendered files.

– **Use unique filenames:** (When rendering Individual Clips, and only when Filename uses is set to Custom name) When enabled, additional characters are added to every rendered media file to guarantee that each rendered media file has a completely independent name. This prevents multiple rendered clips from the same source media file from overwriting one another when saved to the same directory. “Uniquely” named clips append the clip name with the track and clip number identifying a clip’s position in the currently selected session. For example, a clip that’s linked to a media file named “DropThatThingCU.mov,” and edited as the twenty-fifth clip on track V2, will be named “DropThatThingCU_V2-0025.mov” when rendered. When enabled, two other options are revealed.

  – **Use unique filename prefix/Use unique filename suffix:** (When Use Unique Filenames is on) Radio buttons let you choose whether to add the unique identifier at the beginning or end of a clip. Choosing Prefix would result in “V2-0025_DropThatThingCU.mov,” whereas choosing Suffix would result in “DropThatThingCU_V2-0025.mov” when rendered.

  – **Add source frame count to filename:** (When Use Unique Filenames is on) Adds the number of frames in the source to the unique filename being created.

  – **Add source frame count to filename:** (When rendering Individual Clips, and only when Filename uses is set to Custom name) When enabled, a number equal to the number of frames in each clip is appended to the end of the rendered file name. This is another way to make sure that multiple rendered clips with custom names don’t overwrite one another.

  – **Use filename digits:** Lets you specify how many digits to use when rendering an image sequence, although the specified digits will also be used for any media format. This is particularly useful if you’re outputting media to be used by an application that has strict requirements for image sequence numbering. Defaults to eight digits.

  – **Each clips starts at frame:** (When rendering Individual Clips) This permits timecode to be written to the header, and frame count to be written to the filename of the image sequences, which is ideal for VFX workflows.

  – **Start timeline timecode at:** (When rendering Single Clip) This option is only available when rendering clips in Single clip order. Specifies the timecode that will be written to the media being output by DaVinci Resolve. For DPX files, timecode is written into the header data, and is simultaneously converted to a frame count that’s inserted into the filename of each frame file, which provides a logical count of the frame numbers. For other media formats, timecode is written to the appropriate metadata container. You may find it useful to use custom start times, for example starting each reel of a project at a particular value, depending on the standards employed at your shop.

  – **Place clips in separate folders:** (When rendering Individual Clips) Useful if you need to preserve the filenames of files you’re outputting when the filenames of clips coming from the same source media file may cause them to overwrite one another. This option is also commonly used when rendering VFX shots for additional post-production work, allowing the VFX department to identify clips quickly and distribute the work accordingly.
- **Preserve Source directory levels**: (When rendering Individual Clips) Retains a user-specified depth of the original directory structure used by a clip’s corresponding source media file, recreating it when rendering new files for output. The number you select determines how many levels of subdirectories DaVinci Resolve will automatically create within the currently specified “Render job to” directory to match the path used by the source files. Defaults to 0, which creates no matching subdirectories.

- **After Head/From Tail**: When setting how many directory levels of each clip’s file path to preserve (using the “Preserve x levels” parameter), click one of these buttons to specify whether that number of path levels is defined relative to the head or the tail of each media file path.

- **Preserved Path**: Shows you a preview of the preserved path you’ve set up so you know you’ve gotten it right.

- **File Subfolder**: (Only appears in Additional Output panels) Lets you specify a subdirectory into which to render the media files being output. If the specified subdirectory doesn’t exist, a new one with that name will be created within the currently specified “Render job to” directory.

- **Use commercial workflow**: (When rendering Individual Clips) Automatically renders every version that’s applied to each clip in the session, except for versions that have been flagged using the “Render Disabled” flag, found in the Version submenu for each clip in the Timeline. This option is typically used when you’ve graded multiple versions of a clip to be used for VFX work, and you want to deliver each grade as a separate media file. This is also used when rendering programs for commercial broadcast where you have two or more versions of a grade for each scene. When using this option, alternate methods of outputting each rendered media file are used, and four additional settings are revealed.

- **Alternative pass offset**: Lets you separate the timecode values written into each version of a clip with an offset. For example, if the default version timecode is 01:00:20:00, and you select a 10 minute offset in the Alternative Pass Offset timecode entry, then the second graded version of that clip will start at 01:10:20:00, the third version will start at 01:20:20:00, and so on until every version is rendered. You can offset the clips by whatever value you like, but the idea is to make it easy for editors and VFX artists to find the versions of each grade. If the clips are shared with a finishing artist, and they know that each alternate pass is 10 minutes apart, then it’s easy for the finisher to change the clip version just by adding 10 minutes to the referenced timecode. To simplify the workflow further, you can put separate source reels in separate folders using the next three options.

- **Place reels in separate folders**: Automatically places all media that’s output using a particular reel name into corresponding folders.

- **Place clips in separate folders**: Automatically places alternate grades of clips into separate folders.

- **Use version name for folders**: Labels each folder with the name of the version when using the Commercial Workflow option.

- **Render speed**: A drop-down menu lets you throttle the speed at which media is rendered. Ordinarily you’ll leave this set to the default of Maximum. However, some storage systems that are shared by multiple rooms in a facility use storage area networks (SANs) with insufficient bandwidth for multiple real-time image streams. DaVinci Resolve’s incredibly fast rendering speeds can cause playback problems with other users accessing the SAN if available bandwidth is insufficient. In this case, you can throttle the render speed to limit SAN bandwidth usage to between 1 to 50 percent of full rendering speed.

- **Disk space currently used**: Shows the amount of disk space available on the target volume.

- **Disk space used after render**: Shows the new disk usage based on the specified range of the current session that you’re rendering.
Additional Outputs

Each job you create in the Render Settings defaults to a single output. However, you can create multiple outputs when you need to deliver multiple versions of media, with individual video formats and codecs and different data burn-in settings, to be rendered into individually named subfolders (optional).

This can be useful for setting up multiple rendered passes when your client requires two sets of media, for example QuickTime ProRes 422 (HQ) media along with MXF DNxHD media. This is also useful when you need to output two sets of media where one has window burns, and the other is clean.

To add additional outputs in the Render Settings:
– Choose Create Additional Output from the Render Settings Option menu. A row of numbers below the Filename and Location controls let you open each output you create and adjust its settings. You can have as many outputs as you require.

To remove an additional output:
– Open the additional output panel you want to remove, and click the Delete button at the bottom.

How to Avoid Overwriting Clips When Rendering Output Media

Three of the options described previously, “Use unique filenames,” “Place clips in separate folders,” and “Use commercial workflow,” are all ways of organizing your rendered media to avoid overwriting rendered clips that happen to share the same file name. These options are necessary because each clip has one logical range of timecode, and because multiple clips often refer to a single source media file with one name.

When rendering a clip, DaVinci Resolve automatically overwrites any other media files that have the same name. So, in instances where you’re trying to preserve the previous filename of the source media file, or where you’re rendering out multiple versions of the same clip, it’s entirely likely that the clips you’re trying to output will overwrite one another, leaving you with the last clip you rendered. The three options mentioned previously prevent this in different ways.
Defining a Range of Clips and Versions to Render

Once you've defined the Render Settings, now you need to decide how much of the Timeline you need to render. A Mini-Timeline and Thumbnail timeline are available to help you navigate your project's clips in order to choose which ones you want to render. Track controls let you enable and disable whole tracks from being output; for example if you need to render a textless version of a timeline in which all the title clips are on track V4, you can disable track V4. Furthermore, you can also use these controls to choose which clip versions you want to render.

To render the entire Timeline:
- Choose Entire Timeline from the Render drop-down in the Deliver page timeline. This option only appears if clips are not filtered.

To disable a video or audio track to exclude those clips from being rendered:
- Click the Video or Audio Disable Track button for the tracks you want to exclude.

To render a filtered subset of clips in the Timeline:
1. Open the Color timeline, if it's not already shown, and choose an option from the Timeline Filter drop-down to the right of the Clips button in the Interface toolbar.
   The contents of the Thumbnail timeline are restricted to show only the clips matching the selected criteria. For example, if you've already rendered a session, but you've since made some changes, you can use one of the "Show Modified Clips" options to display only the clips that have changed within a particular timeframe. Another possibility is to choose the "Show Unrendered Clips" option to show all clips that have not yet been rendered.
2. Choose "All Filtered Clips" from the Render drop-down in the Timeline toolbar.

To clear clip filtering:
- Choose All Clips from the Timeline Filter drop-down to the right of the Clips button in the Interface toolbar.

To define a continuous range of clips to render:
1. To define the first clip in the range you want to render, do one of the following:
   - Right-click a clip thumbnail in the Thumbnail timeline and choose Mark In.
   - Position the playhead in the Timeline or the Viewer, and press the I key, or right-click the Timeline ruler and choose Mark In.
2. To define the last clip in the range you want to render, do one of the following:
   - Right-click a clip thumbnail (in the Color timeline) or a clip (in the Edit timeline) in the Thumbnail timeline and choose Mark Out.
   - Position the playhead in the Timeline or the Viewer, and press the O key, or right-click the Timeline ruler and choose Mark Out.

In and Out points appear within the Timeline ruler, and an orange bar shows the range you've selected to render. The In and Out fields update with the first and last frame numbers, in timecode and frame count, and the Duration field updates with the total number of frames you'll be rendering.
If you’re in Individual Clips mode, In and Out points automatically snap to the nearest clip In or Out point in the Timeline. You cannot render partial clips in Individual Clips mode, but you may do so in Single Clip mode.

**To render a single clip:**
- Open the Thumbnail timeline if it’s not open already, Right-click any clip thumbnail, and choose Render This Clip.
- An orange bar in the Timeline ruler shows that clip is selected for rendering. If you need to render several clips individually, you can select each clip one at a time to add as individual jobs to the Render Queue.

**Choosing Which Versions to Render for Each Clip**

By default, the currently selected version that was set in the Color page is rendered for each clip. If you want to render a different version, the easiest thing to do is to make sure they’re selected on the Color page Timeline before you open the Deliver page.

However, a Versions submenu, within the Thumbnail timeline’s contextual menu for each thumbnail, also provides options to manage grade versions. These commands are duplicates of options that are available from the Thumbnail timeline of the Color page.

**To choose which version to render:**
- Right-click any clip thumbnail in the Thumbnail timeline, and choose a version from the Versions submenu.

**TIP:** You can right-click a clip in the Thumbnail timeline of the Color or Render screen and rename any version of a grade. This can assist a facility’s workflow when sharing material between suites and applications.

**Using the Render Queue**

Once you’ve defined the settings necessary to render the type of media you require, and the range of the current session you want to render, you need to add all that information as a job to the Render Queue. You can add as many jobs to the Render Queue as you need, depending on what files you need to output.

Each job can have individually specified ranges of clips and individual clip settings, which can include different render directories, different formats, resolutions, data levels, burn-in settings, and so on. As a result, you can use the Render Queue to queue up the render of multiple sections of the current session, or multiple versions of the same media. Furthermore, you can queue up multiple sessions, if you have several differently graded sessions.

**To add a job to the Render Queue:**
1. Select a timeline.
2. Choose the settings you require in the Render Settings, using one of the Presets, or by choosing your own custom settings.
3. Choose a range of clips to render using the Deliver page Timeline using the procedures described in the previous section.
4. Click the Add to Render Queue button at the bottom of the Render Settings.
5 If you haven’t chosen a location for the render yet, you’ll be prompted to do so now via a File Destination dialog, so choose a location and click Ok. If there’s already media in the render location you’ve specified, you may also see a dialog telling you “This render may overwrite existing clips in this folder.” If you want to continue, click Yes, otherwise click No.

That render setup is now added as a job to the Render Queue, showing the project and timeline name, and location path where the render will be written to.

![A selected job in the Render Queue](image)

**Media Offline Warning in Render Queue**

When you attempt to add a job to the Render Queue with a timeline that contains any offline material, DaVinci Resolve automatically gives you a warning. You may choose to either cancel adding the job, or to add it anyway, knowing you’re about to render one or more offline clips.

![Media Offline warning box that appears if your timeline contains offline clips or frames and is added to the Render Queue](image)

**To show more details about jobs in the Render Queue:**

- Click the Render Queue Option menu (at the upper right-hand corner) and choose Show Job Details. Each job now lists the frame size, format, frame rate, audio channels and sample rate, and duration below the name and location path.

![A selected job in the Render Queue with job details shown](image)

**To rename a job:**

- Jobs can be given custom names simply by clicking on the default job name (Job 1, Job 2, and so on) and typing a new name of your own. This can be useful for setting up jobs that you may be re-rendering over and over as you work on a project.

**To start rendering:**

1 If you want to restrict rendering to only selected jobs in the Render Queue, then select one or more jobs by clicking on one, and then Command-clicking on others to choose discontinuous jobs, or Shift-clicking on another to select an entire range of jobs. When you select one or more jobs, only the selected jobs will be rendered. If no jobs are selected, then all jobs in the queue will be rendered.
2 Click the Start Render button, underneath the Viewer to the right of the interface.

3 If there are jobs in the Render Queue that have already been rendered, a dialog will appear asking “Selected items contain already rendered items. Do you want to re-render them?” Clicking Yes will re-render all jobs in the Render Queue. Clicking No only renders the jobs that have not yet been rendered. Clicking Cancel cancels the entire rendering operation.

Rendering begins, starting with the highest job in the list. The Overall Progress bar starts to fill up, from right to left, indicating how much of what’s been queued up has been rendered so far. While rendering is in progress, the Start Render button changes to the Stop Render button, which can be clicked at any time to halt rendering.

**TIP:** While rendering is in progress, a small progress bar will appear on the DaVinci Resolve icon in the dock of Mac OS X, or on the taskbar of Windows.

To remove jobs from the Render Queue, do one of the following:

- **To clear a specific job:** Click the X at the upper right-hand corner of a job’s entry in the Render Queue.

- **To clear all previously rendered jobs:** Click the Render Queue Option menu (at the upper right-hand corner) and choose Clear Rendered.

- **To clear all jobs:** Click the Render Queue Option menu (at the upper right-hand corner) and choose Clear All.

To change a job that has been rendered to appear unrendered again:

- Right-click any rendered job, and choose Clear Render Status. You can also select multiple jobs to change their rendered status all at once. This makes it easy to re-render the exact same job.

To edit a job that has or has not been rendered:

1 Click the Pencil button in the Render Queue to select it.

![Clicking the pencil icon to edit a job in the Render Queue](image)

The selected Render Queue’s settings repopulate the Render Settings list, and resets the selected range of the Timeline corresponding to that job.

2 Change whichever settings you need to.

3 When you’re finished editing the job, click the Update Job button that appears at the bottom of the Render Settings, or you can click Add New Job to create a new job with the changes you’ve made, leaving the previous job untouched.

**NOTE:** If you click the Pencil button again without clicking Update Job, you’ll be prompted to Save, Cancel, or Don’t Save.
To review clips that correspond to rendered jobs:

– To show a rendered clip in the Media Storage browser: Right-click any rendered job, and choose Reveal in Media Storage.

– To show a rendered clip in your computer’s file system (Mac OS only): Right-click any rendered job, and choose Reveal in Finder.

Rendering Jobs from Multiple Projects at Once

You can also add multiple projects from the currently open PostgreSQL or Disk database to the render queue all at once. This can be exceptionally useful in situations where you’ve broken a program into multiple reels, with each reel being a different project.

To render output from multiple projects at once:

1. Open each project, set up whatever jobs you want to render in the Render Queue, and save that project without rendering.

2. When you’ve set up the last project, click the Render Queue Option menu (at the upper right-hand corner) and choose Show All Projects.

3. All queued items in projects belonging to the currently selected user (if using a PostgreSQL database) or in the currently specified disk location (if using a disk database) now appear in the Render Queue.

4. Click Start Render to begin rendering every job from every project in the queue.

5. When you’re finished, turn Show All Projects off to go back to displaying only the current project’s render queue items.

Remote Rendering

If you have multiple DaVinci Resolve workstations on the same network, you can send a job in the Render Queue from the workstation you’re using (referred to as the “artist workstation”) to one of the “remote workstations” on the network using remote rendering. This lets you use any one of your currently unused secondary workstations to render your jobs, while you continue working on your main workstation.

In order to use remote rendering, you must adhere to the following three criteria:

– Both the artist workstation and the remote workstation must have DaVinci Resolve Studio installed. Remote rendering does not work with the free version of DaVinci Resolve.

– Both the artist workstation and the remote workstation can use the same Postgres shared database, or any other Postgres database that is connected to either one of the machines, or to a dedicated Remote Database Server. For more information on setting up and using a shared databases, see Chapter 193, “Managing Databases and Project Servers.”

– Both the artist workstation and the remote workstation must have access to the same media files on either the same storage volumes, or identically named storage volumes.

Using Multiple Databases in Remote Rendering

You can set up remote renders for projects in all connected Davinci Resolve databases, not just the currently active one. To activate this feature, check the “Automatically scan other databases for Remote Rendering jobs” box in the General settings of the System tab, of the DaVinci Resolve Preferences.
Sharing Storage

It's important that both the artist and remote workstations have access to the same media on the same named storage volume for remote rendering to work properly. This can be done via some manner of shared storage, such as a SAN. However, it can also be done by mounting the same volume over your network. This will be slower, but it will work.

If you’re mixing Mac OS X, Windows, and Linux workstations for remote rendering, you’ll need to use the Mapped Mount column of the Media Storage Locations list in the Media Storage panel of the System Preferences to add each volume’s path as it’s understood on the workstation it’s attached to. For example, on a Windows workstation that’s accessing volumes from a Linux workstation, type in the Linux-style file paths in the Mapped Mount column for each scratch disk that’s listed.

Setting Up and Using Remote Rendering

Using remote rendering is easy, but it does require a bit of preparation.

1 Make sure the storage volume containing the media being referenced by the project you want to render is mounted on both the artist and remote workstations.

2 Open DaVinci Resolve on the remote workstation, and do one of the following:
   – When the Project Browser opens, right-click anywhere and choose Remote Rendering.
   – If you’ve already opened a project in DaVinci Resolve, you can also choose Workspace > Remote Rendering.

DaVinci Resolve will automatically open to the Deliver page, awaiting jobs to be assigned for automatic rendering.

3 On the artist workstation, add a job to the render queue as you normally would.

4 Click the Remote Rendering button for that job in the Render Queue and one of the options from the list that appears:
   – **Any**: Automatically assigns that job to the next workstation that isn’t currently rendering anything. If all remote rendering workstations are rendering, assigns it as the next job in line.
   – **YourComputer.local**: The artist workstation with the name “YourComputer.” Choose this if you want to render the job locally, and not remotely.
   – **Other Workstations on Network**: All other remote rendering workstations are listed below, so you can choose which specific workstation you want to assign a job to.

5 Click Start Render. The job is sent to the remote workstation you selected and is rendered, while you’re free to continue working on your artist workstation.
When You’re Finished Remote Rendering

Once you’re done using a particular DaVinci Resolve workstation in Remote Rendering mode and you want to go back to using it as an artist workstation, choose Workspace > Remote Rendering to exit remote rendering and return to the Project Manager.

Setting Up a “Headless” Remote Rendering Workstation

DaVinci Resolve allows remote rendering clients to operate in a so-called “headless” mode, with no GUI. This can be accomplished from the command line, by opening the directory where the app is located and then running DaVinci Resolve in Remote Rendering (–rr) mode using the correct command line syntax for your operating system. Once run in this way, DaVinci Resolve silently and invisibly waits on that system for remote rendering jobs to be sent to that workstation.

On macOS
  – Open Terminal.
  – Change the directory to:
    
    cd /Applications//DaVinci\ Resolve/DaVinci\ Resolve.app/Contents/MacOS/
  
  – Run the following command:
    
    ./Resolve -rr

On Windows
  – Open the Command Prompt.
  – Change the directory to:
    
    C:\Program Files\Blackmagic Design\DaVinci Resolve\
  
  – Run the following command:
    
    Resolve.exe -rr
On a Linux CentOS 6.8 system
– Open Terminal.
– Change the directory to:
  `cd /home/resolve/Cyclone/`
– Run the following command:
  `./script.start -rr`

On a Linux CentOS 7.x system
– Open Terminal.
– Change the directory to:
  `cd /opt/resolve/bin`
– Run the following command:
  `./resolve -rr`
Chapter 187

Delivering DCP and IMF

For projects requiring Digital Cinema Package (DCP) or Interoperable Master Format (IMF) mastering for digital cinema or broadcast distribution, DaVinci Resolve allows native DCP and IMF encoding and decoding for the creation and playback of unencrypted DCP and IMF deliverables, or it can be integrated with Fraunhofer’s easyDCP application in order to master fully encrypted DCP files, play them back for testing, and generate Key Delivery Messages (KDMs) for theatrical distribution, all directly within DaVinci Resolve.

This means you can encode a DCP or IMF master straight from your program’s source media, all within the 32-bit floating point image processing pipeline of DaVinci Resolve, for the highest possible quality result.

Contents

Native IMF Encoding and Decoding 3529
Native Unencoded DCP Encoding and Decoding 3531
Native DCP Encoding Parameters 3531
Rendering IMF Segments and DCP Reels 3533
Creating DCP/IMF Supplemental Packages 3534
Importing a DCP or IMF Into a Timeline 3534
Editing the Resulting Timeline 3535
Dolby Vision Metadata 3536
Exporting 3536
Photon Validation of IMF Packages 3537
Validating in the Media Pool 3537
Validating on Export 3538
Native IMF Encoding and Decoding

Available in DaVinci Resolve Studio Only

The Format drop-down in the Video panel of the Render Settings now has a native IMF option that lets you export to the SMPTE ST.2067 Interoperable Master Format (IMF) for tapeless deliverables to networks and distributors. No additional licenses or plug-ins are required to output to IMF.

The IMF format supports multiple tracks of video, multiple tracks of audio, and multiple subtitle and closed caption tracks, all of which are meant to accommodate multiple output formats and languages from a single deliverable. As of DaVinci Resolve 16, IMF export also supports exporting IMF packages that use ST.2098 and Dolby immersive audio via selected Main busses. All of this is done by wrapping a timeline’s different video and audio tracks (media essences) and subtitle tracks (data essences) into a “composition” within the Material eXchange Format (MXF).

Additionally, a drop-down menu to the right of this preset provides options for Generic, 20th Century Fox, and Netflix versions of this preset.

When IMF is selected from the Format drop-down, the Codec drop-down menu presents options for Kakadu or EasyDCP encoding, with Kakadu being the method that’s included with DaVinci Resolve Studio. A Type drop-down lets you choose what kind of JPEG2000 output you want, with options including RGB, YUV, and Dolby Vision. Additional parameters include:

- **Package Type**: Defaults to App2 Extended (App2e), for encoding JPEG 2000 up to 4K.
- **Bit Depth**: The bit depth of the encoded IMF video.
- **Encoding Profile**: A drop-down that lets you choose among Auto, IMF, and Broadcast.
- **Encoding Level**: Provides different choices based on what is selected in Encoding Profile.
- **Maximum bit rate**: Lets you choose how much to compress the result.
- **Lossless Compression**: Lets you choose to encode using lossless compression.
– **Slope-Rate Control**: A checkbox lets you specify lossless compression.
– **QStep**: (DCP, IMF) Lets you choose either automatic or manually specified DCP quantization levels at which to compress the video signal when using the Kakadu JPEG 2000 encoder.

![Render settings in the Export Video section for the IMF format](image)

A separate group of parameters named Composition Settings, underneath the Advanced Settings, lets you add metadata to your IMF package, including:

– **Composition name**: The name of the exported composition.
– **Issuer**: The organization providing the composition.
– **Use current date**: A checkbox that lets the current date be used as the issue date automatically.
– **Issue date**: The date the composition is issued.
– **Content kind**: A drop-down provides a list of acceptable choices for defining the content.
– **Content version label**: Meant to identify the version of the content being provided.
– **Annotate xml using composition name**: Auto-populates Asset Map, Composition Playlist, and Packing List with data from the project. Otherwise these three fields are manually editable.
– **Annotate media using filename**: Auto-populates Main Video Track and Audio Track 1 with data from the project. Otherwise these three fields are manually editable.

![Parameters for adding composition metadata](image)
Native Unencoded DCP
Encoding and Decoding

Available in DaVinci Resolve Studio Only

DaVinci Resolve also has native DCP encoding and decoding support built-in, for unencoded DCP files only. That means that you can output and import (for test playback) unencoded DCP files without needing to purchase a license of EasyDCP. If you have a license, a setting in the Configuration panel of the System Preferences enables you to choose whether to use EasyDCP (for creating encrypted DCP output), or the native DaVinci Resolve encoding.

Native DCP Encoding Parameters

When you choose DCP from the Format drop-down menu, the following additional parameters are exposed:

- **Use interop packaging**: (DCP only, located under Type parameter) Lets you create an Interop DCP package, based on an earlier standard of DCP delivery that is not forward compatible with SMPTE DCP packages.
- **Maximum bit rate**: (DCP, IMF) Lets you choose how much to compress the result.
- **Lossless Compression**: (IMF) Lets you choose to encode using lossless compression.
- **Slope-Rate Control**: (DCP, IMF) A checkbox lets you specify lossless compression.
- **QStep**: (DCP, IMF) Lets you choose either automatic or manually specified DCP quantization levels at which to compress the video signal when using the Kakadu JPEG 2000 encoder.

Native DCP settings in DaVinci Resolve

If you’ve selected DCP from the Format drop-down menu, a Composition Settings group appears with the following parameters when you click the disclosure control, which let you populate standard DCP composition metadata:
- **Composition name**: The name of the exported composition. DCPs use specific naming conventions for the composition name that include metadata about the file itself for DCP projectors and playback equipment. DaVinci Resolve has a tool called the Composition Name Generator to generate these names properly for you; it is accessed by pressing the “Edit” button next to this field. Simply fill out the fields and press OK, and DaVinci Resolve will rename your composition in line with these standards.

![Composition Name Generator](image)

The Composition Name Generator will pass a standards compliant name for you to the Composition Name field.

- **Issuer**: The organization providing the composition.
- **Use current date**: A checkbox that lets the current date be used as the Issue date automatically.
- **Issue date**: The date the composition is issued.
- **Content kind**: A drop-down provides a list of acceptable choices for defining the content.
- **Content version label**: Meant to identify the version of the content being provided.
- **Annotate xml using composition name**: Auto-populates Asset Map, Composition Playlist, and Packing List with data from the project. Otherwise these three fields are manually editable.
- **Annotate reel index as suffix**: Auto-populates Reel Annotation with data from the project. Otherwise this is manually editable.
- **Annotate media using filename**: Auto-populates Main Video Track and Audio Track 1 with data from the project. Otherwise these three fields are manually editable.
Parameters for adding composition metadata

Rendering IMF Segments and DCP Reels

DaVinci Resolve supports splitting IMF and DCP projects into separate segments and reels, in addition to rendering media as a single file. This can be useful for breaking up your timeline to fit within allowed file sizes on legacy file systems, separating marketing and studio assets from the final film, or just being able to replace certain sections of the film without having to re-encode the entire file.

To Render an IMF Segment or DCP Reel:
1. Choose IMF or DCP from the format settings in the Video tab of the Render Settings panel.
2. Navigate to the “Segment list” or “Reel list” section of the composition settings.
3. Choose from the following options:
   - Single segment/reel: Encodes the Timeline into a single file (default setting).
   - Regular intervals of: Encodes the Timeline into multiple segments/reels, each one the duration of the value set in the “mins” field.
   - Align to clips on the first video track: Encodes the Timeline into multiple segments/reels; each individual clip on the V1 track of the Timeline becomes its own separate file.
   - Keep audio as single segment (IMF only): Select this checkbox to keep the audio portion of the IMF as a single file, regardless of the segment options selected above.
4. Press the Add to Render Queue button.
Creating DCP/IMF Supplemental Packages

Once created, DaVinci Resolve has the ability to reimport a DCP or IMF so that you can overwrite parts that need to be updated with new media, in order to export a “Supplemental Package,” which is effectively a new version of the program that combines the new overwritten parts of the program with the old version, such that you can deliver just the changes.

**NOTE:** Supplemental packages are only supported using the Kakadu encoder and decoder; this is not compatible with DCP or IMF packages created using EasyDCP. To avoid issues, disable “Use easyDCP decoder” in the Decode Options panel of the DaVinci Resolve System Preferences.

Importing a DCP or IMF Into a Timeline

1. Using the Media Storage browser in the Media page, find and select the DCP or IMF, and check the header of the Metadata Editor to verify that your media is suitable for creating a supplemental package. Supported IMF profiles will be displayed in the Metadata Viewer.

   ![Metadata Editor Header](image)

   The header in the Metadata Editor showing an IMF that's compatible with the creation of a supplemental package

2. Create a new project and add the DCP/IMF package you need to modify to the Media Pool. If a dialog appears asking if you want to change your timeline frame rate to match the incoming media, click Change to make your project match the media.

3. Create a timeline from the composition playlist (XML) within the imported DCP or IMF by right clicking the imported package in the media pool and choosing “Create New Timeline Using Composition Playlist” from the contextual menu.

   ![Contextual Menu](image)

   Right-clicking an imported IMF or DCP clip in the Media Pool reveals a command to make a new timeline using the composition playlist in the contextual menu

4. The New Timeline dialog has an “Import Dolby Vision Project Settings” checkbox. When it’s turned on, clicking Create will do the following:
   a. Dolby Vision will be enabled in the Color Management panel of the Project Settings, and the Mastering Display menu will be set to match that of the IMF package.
   b. If Resolve Color Management (RCM) is not active, the Timeline Color Space will be set to match the Dolby Vision metadata. However, if RCM is already enabled, the user must manually set this by turning on “Use Separate Color Space and Gamma,” and changing the Timeline settings to P3-D65” and “ST.2084” respectively.
Creating the Timeline will import Dolby Vision metadata (if applicable). This will allow a Tone Mapping preview to be seen on the Color page that uses the original metadata.

Dolby Vision metadata will be imported if present when importing an IMF.

Once import is complete, all video and audio clips from the DCP or IMF appear within a new bin with the name of the package. The resulting timeline will be identified via its icon as a DCP/IMF timeline.

The imported media and timeline when you import an IMF

Editing the Resulting Timeline

At this point, you can edit the program in the Timeline as necessary.

– You can overwrite sections of the Timeline with new clips. All modifications will be automatically included into the supplemental package.
– You can use the Blade tool or Insert Edit command to cut sections of the existing program to which you want to add Fusion effects, audio grading, or color correction. When you do this, you must right click that section and choose “Include in Supplemental Package” to make sure it exports correctly.

For IMF Dolby Vision packages, please ensure all modifications are on the first video track (V1).

**NOTE:** If RCM is being used, please ensure the input color space and gamma of the inserts are correct.
Dolby Vision Metadata

The Dolby Vision metadata from the imported DCP/IMF file can be reused by selecting "Original Metadata" from the Tone Map Using drop-down menu of the Dolby Vision palette in the Color Page.

Alternatively, this metadata can be imported separately from an existing XML via the “Import Metadata from XML” command in the option menu of the Dolby Vision palette in the Color page. When successful, “Imported Metadata” will be enabled.

Exporting

You can export a supplemental package by turning on “Supplemental Package” in the video panel of the Deliver page Render Settings list.

The codec type and profile will be automatically selected to match the original version of the DCP/IMF package, and the audio tracks are set to match the Timeline tracks. Please ensure the rest of these audio settings are matched to the original version, since they start out set to the default values.
Photon Validation of IMF Packages

Photon is Netflix’s validation software for IMF App2/App2e packages. The option for using Photon validation will only be shown on Resolve Studio with JDK/JRE version 1.8 and above installed, which is available at https://github.com/Netflix/photon.

**NOTE:** Please disable “Use easyDCP decoder” from “Preference” as there can be issues decoding IMF packages without an easyDCP license.

Validating in the Media Pool

An existing IMF package can be validated with Photon by importing it into the Media Pool, then right-clicking it and choosing “Perform Photon Validation” from the context menu.
A report dialog will be shown when the validation is completed.

Validating on Export

Photon validation can be enabled in the File panel of the Deliver page Render Settings; choosing the "IMF Netflix" preset will also enable this option. When enabled, DaVinci Resolve will perform Photon validation after the IMF package is exported. The validation report will be saved to a text file in the IMF package folder, and a report dialog will be shown if there is any error.
Using and Licensing EasyDCP

Both DaVinci Resolve and DaVinci Resolve Studio include a demo version of easyDCP. Details of operation and restrictions of the demo version can be found later in this chapter. The fully functional version of easyDCP operates via licensing modules purchased from http://www.easyDCP.com (info@easyDCP.com) and every new DaVinci Resolve system (server) needs its own license and specific certificates for DCP and KDM generation and for playback of DCPs.

Requesting Your Server Certificate Set

For your DaVinci Resolve system to generate DCPs and KDMs you need to request a specific set of configuration files called the Server Certificate Set. To begin, first purchase your encoding, encryption, decoding, and decryption modules from easyDCP. They will provide a password to access your easyDCP account.

Then, from the DaVinci Resolve File menu, select easyDCP > Request Server Certificate Set. Fill in the detail listed on the request form and save the form to your desktop or somewhere it can be easily found. This html file can be emailed to info@easyDCP.com. After sending the html, a customized Server Certificate Set for your installation will be generated and made available for download in your easyDCP Website User Account.

The Server Certificate Set generated for your DaVinci Resolve will contain files based on your purchased modules and your specific DaVinci Resolve server hardware. The table below shows the modules and the licenses and certificates generated, followed by a brief description of each item.

<table>
<thead>
<tr>
<th>License</th>
<th>Server Certificate</th>
<th>Signer Certificate</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCP Encoder</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>DCP Encoder with Encryption</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>DCP Player</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DCP Player with Encryption</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

- **License**: The License is used to activate the purchased modules on a specific hardware server.
- **Server Certificate**: Each DCP render (referred in the industry as an “Instance”) using encryption or decryption has an individual server certificate. This certificate is required to be able to receive Key Delivery Messages (KDMs), which unlock encrypted DCPs.
- **Signer Certificate**: A Signer Certificate is used to sign certain files within a DCP package and/or Key Delivery Message (KDM) to verify which authority generated the DCP instance.

Importing Your Server Certificate Set

Once generated and downloaded to your DaVinci Resolve server, the Server Certificate Set needs to be imported into DaVinci Resolve.

**To import your server certificate:**

1. Choose File > easyDCP > Import License and Certificates.
2. Use the Import Server Certificate dialog to select the file, enter your Certificate Set password, then click Import.
3. To verify your easyDCP license and the Server Certificates, choose easyDCP > About easyDCP.
From this point onward, you can use the controls from within the Settings window, the Deliver page, and the File menu to master and play DCPs.

**Limitations of the Demo Version of easyDCP**

The demo version of the DCP encoder embeds visible DaVinci Resolve and easyDCP logo watermarks in the rendered Digital Cinema Package (DCP) images. The demo version does not include encryption so these DCPs can be used for screening in a digital equipped cinema. The demo version of the DCP playback module will play 15 seconds in full quality. After that playback quality reduces drastically. Furthermore, audio won’t be rendered after 15 seconds of playback.

**Switching Between Native DCP and EasyDCP Encoding**

A checkbox in the Configuration panel of the System Preferences, “Use EasyDCP Encoder,” lets you choose whether to use the native DCP/IMF encoding in DaVinci Resolve, or your licensed EasyDCP software. In either case, all set up happens from within the Deliver page of DaVinci Resolve.

**EasyDCP Color Management**

The Color Management panel of the Project Settings has a Timeline Colorspace drop-down menu that is enabled for EasyDCP encoding regardless of whether or not DaVinci Resolve Color Management is used for the current project (the same setting is used for both color management tasks). You should set this to the color space used by your current DaVinci Resolve timeline. If, for example, you are grading using a Rec. 709 monitor for television deliverables but also wish to make a DCP, select Rec. 709 Gamma 2.4 and DaVinci Resolve will render the DCP with the correct Rec. 709 to XYZ matrix.

**EasyDCP Output in the Deliver Page**

To master to a DCP in the Deliver page, use the following procedure, which walks you through all of the easyDCP settings that are available in the Render Settings list.

**To master a DCP or IMF:**

1. Set “Render timeline as” to Single clip.
2. Choose easyDCP from the Video Format drop-down.
3. Choose the appropriate option from the Codec drop-down that corresponds to the type (DCP or IMF) resolution (2K or 4K), and aspect ratio (native, scope, or flat) of your intended output.
4. Set the Composition Name. This field is intended to hold a standardized name for the DCP being encoded. You can either type a name into this field directly, or you can press the “… ” button to open the easyDCP Composition Name Generator window. An editable Film Title field appears, along with a number of drop-down menus that let you select various DCP attributes such as content type, aspect ratio, language of audio and subtitles, and so forth. As you populate each attribute, the name being generated appears at the top of the window, and clicking OK copies the resulting Composition Name into the Composition Name field of the Render Settings.
5 If necessary, set the desired “Maximum DCP bit rate” by either typing or dragging within the field (the range is 50 to 250 Mbit/sec). If you’re not sure what data rate to use, consult the client or distributor to whom you’re delivering the DCP.

6 There are two DCP package types you can output, determined by the “Use Interop packaging” checkbox:
   – The standard package conforms to the “Interop” specifications for DCPs, which is turned on by default. With “Use Interop packaging” turned on, however, the frame rate of your output is limited to either 24fps or 48fps, so you need to make sure that your timeline conforms to these frame rates.
   – If you want to generate DCP packages with other frame rates to match your timeline, you need to turn “Use Interop packaging” off to generate a SMPTE-standard DCP. This supports additional frame rates including 25, 30, 50, and 60 fps. However, SMPTE-Standard-DCPs are not supported on all JPEG2000-based playback systems so it’s generally recommended to use the Interop standard unless you know the player supports the SMPTE-Standard DCPs.

7 Turn on the “Encrypt package” checkbox to encode an encrypted DCP. This sets the encoder to generate a Digest containing the keys used during encryption. This Digest will allow you to play the resulting DCP on your system, and to generate KDMs to allow that DCP to be played on other servers.

   **NOTE:** If you do not encrypt the DCP it can be played on any DCP player/decoder without restriction.

8 Set the Subtitles Path. If you have a properly formatted subtitle file, click the Browse button to link to it.

9 If you’re including an audio mix in the DCP, go to the Audio section, turn on the Render audio checkbox, and choose the number of channels in the “Render channels of audio” drop-down menu that corresponds to the number of Audio Mixer output channels defined in the Edit page.

10 Click the Browse button under the “Render to” field, and choose a location for the resulting DCP. Make sure you pick a drive with enough room for the estimated size of the final DCP.

11 Choose all necessary options from the Output Options to ensure the quality you need.

12 Click the Add Job to Render Queue button, and then click Start Render to create your DCP. A DCP will be created and placed at the location you chose, ready for playback or delivery.

**KDM Generation and Management**

Key Delivery Messages (KDMs) are required to allow an encrypted DCP play on a designated projector at a particular theater at a specified time. DaVinci Resolve is capable of creating KDMs, which is convenient for exporting KDMs for select screenings, but commercial distributors may require thousands of KDMs. Fortunately, easyDCP allows you to use external Distribution KDM (DKDM) utilities to generate KDMs for your clients, so you don’t have to tie up your DaVinci Resolve workstation with this task.

**Publishing Your Encrypted Digital Cinema Package**

While you can play your encrypted DCP on the same DaVinci Resolve system that generated it, if you wish to publish the DCP so other players can decode and play you need to generate a KDM to send to the player. The user of the other player, or players, will need to generate a Server Certificate for each of their players and send this to you so when you generate the KDM it will be just for those players.
Select the DCP in the Media page Library. Right-click and select Generate KDMs. From the drop-down select the location of the Server Certificate file if the KDM is for one player, or folder for multiple players. Set the start and end dates that the KDM will be valid for, an output folder to place the KDM, and then select Generate.

You can now send your DCP and the KDMs to the player you authorized. The user there will import the KDM and the DCP will play between the start and end dates.

Playing Your Digital Cinema Package

To play a DCP you’ve output from DaVinci Resolve, use the Media page to add it to the Media Pool and edit it into a timeline like any other clip.

Decoding the JPEG2000 images embedded within the DCP in real time is computationally intensive. If your system is underpowered you can reduce the decoded resolution of the files by selecting Half or Quarter Resolution Decode from the File > easyDCP menu. A smaller, less bandwidth-intensive version of the JPEG2000 files will be decoded by discarding some levels of the wavelet stage inside the decoder, which will directly increase the playback performance.

Playing Third-Party Digital Cinema Packages

To play a non-encrypted DCP simply select the DCP in the Media page like any other clip. To play an encrypted DCP from a third party you first must publish your Server Certificate. They use the certificate to generate KDMs for their DCP to play on your DaVinci Resolve system. From the File menu choose easyDCP > Export Server Certificate, and on the drop-down menu choose a location to save the file. Send this to the third party for KDM generation.

When you receive a KDM or a Digest for an encrypted DCP you must first import the file into your DaVinci Resolve system. Choose File > easyDCP menu > Import KDM/Digest, and then select the file. Then simply select the encrypted DCP in the Media Page Library to play.
Chapter 188

Delivering to Tape

This section covers how to use the Deliver page to output a timeline, either in whole or in part, to a device-controllable VTR connected to a compatible Blackmagic Design video interface. For whichever output interface you use, you need to make sure that the RS-422 interface is connected to that of the VTR, and that device control has been established.

Contents

The Tape Output Interface 3544
Gang Timecode to Tape 3544
Insert/Assemble Drop-down Menu 3545
Start Record Button 3545
Setting Up for Tape Output 3545
General Options 3545
Capture and Playout Settings 3545
Capture 3546
Playout Settings 3547
Edit to Tape Queue Option Menu Settings 3547
Tape Output Procedures 3548
Power Mastering 3548
Outputting a Program From the Timeline 3548
Batch Outputting Multiple Clips 3549
The Tape Output Interface

Tape output is accomplished on the Deliver page, which has to be placed in the Tape mode before you can proceed.

To switch to tape output in the Deliver page:

– Click the Tape button, which is the third button from the left on the Interface toolbar at the top of DaVinci Resolve. The Deliver page updates to reflect the relevant controls for editing to tape.

While in Edit to Tape mode, the Deliver page is used to control the VTR, in order to establish In and Out points for insert or assemble editing of the selected portion of the current Timeline to tape.

– **Capture and Playout:** The Render Settings panel turns into the Capture and Playout panel, with controls and settings governing how DaVinci Resolve will output your program to tape.

– **Edit to Tape Queue:** The Render Queue turns into the Edit to Tape Queue, which lets you set up a batch of either previously rendered media files, or In and Out point-defined segments of the current Timeline for simultaneous output to tape.

– **Transport controls:** The transport controls, while similar in appearance to those used while in Render mode, now control the VTR. While in Edit to Tape mode, the transport controls of the DaVinci control panel also control the deck, rather than your program.

– **Shuttle control:** A shuttle control appears in what was formerly the jog or scrubber bar, which lets you shuttle through the range of reverse and forward speeds compatible with that deck.

– **In and Out controls:** In Edit to Tape mode, the In and Out buttons to the right of the transport controls define a range of the tape to Insert or Assemble edit to, within the current Timeline. While in Edit to Tape mode, you can still define In and Out points to define a specific range of the Timeline by right-clicking a clip in the Thumbnail or Mini-Timeline, and choosing Mark In or Mark Out. You can only add In or Out points to the beginning and end of clips.

– **Cue In and Cue Out controls:** Buttons next to the timecode In and Out fields cue the tape to those frames on tape.

Gang Timecode to Tape

When the Deliver page is in Tape mode, you can right-click the ruler running along the top of the Timeline and choose “Gang Timecode to Tape,” which puts DaVinci Resolve into a mode where every time you set an In point on the Deliver page Timeline, a corresponding In point is automatically set on the tape deck. Setting both In and Out points on the Deliver page Timeline results in the In and Out points on the tape deck being set at the same timecode, making it easy to set up insert edits to tape on top of a previously output program.
Insert/Assemble Drop-down Menu

A drop-down menu under the In and Out buttons lets you choose how to edit the selected part of the Timeline to tape. There are two options:

- **Insert**: Performs an insert edit to tape, in which selected tape tracks are seamlessly and frame-accurately overwritten without interrupting the timecode or control track. You must be outputting to either a blacked tape, or a prerecorded tape to make an insert edit.

- **Assemble**: Performs an assemble edit, in which every track of tape is overwritten, including the video, audio, timecode, and control tracks.

- **Crash**: (Only appears if “Output Source Timecode” has been enabled in the Playout section of the Capture and Playback panel of the Project Settings) Similar to an assemble edit, except there is no pre-roll period to let the VTR get up to speed. A crash edit also overwrites every track of the tape, including the video, audio, timecode, and control tracks, and may result in a more visible jump at the resulting edit point. However, in some instances crash edits may be the only option for a particular operation.

**NOTE**: When DaVinci Resolve is performing a Batch Output operation, you can only output clips using assemble editing or crash recording.

Start Record Button

Once you’ve set In and Out points to define how much of the tape to record to, the Start Record button initiates device-controlled tape output.

Setting Up for Tape Output

Before you perform an edit to tape, the Capture and Playback panel of the Project Settings has a number of options that you should set to match the format and type of tape output you’re doing.

General Options

The Output LTC checkbox, when turned on, directs DaVinci Resolve to output LTC timecode.

Capture and Playout Settings

These settings affect both capture and playback when using the Tape Ingest options of the Media page, or the Tape Output options of the Deliver page.

- **Video capture and playback**: You can choose the video format (frame size and frame rate) with which to output to tape from this drop-down menu. HD timelines can be downconverted to SD, and SD timelines can be upconverted to HD using the format conversion of your DeckLink card.

- **Use left and right eye SDI**: A checkbox that enables supported video interfaces to ingest and output muxed stereoscopic video when used with supported VTRs, such as HDCAM SR decks with 4:2:2 x 2 mode. (When muxed stereoscopic signals are ingested, each eye is separated into individual left-eye and right-eye image files.) This parameter only appears when your hardware is set up appropriately.

- **Video connection operates as**: Selects between the available signal options: Use 4:4:4 SDI, and enable Single Link. Which options are available depend on which video capture card you are using.
– **Data Levels**: Lets you specify the data range (normally scaled or full range) that’s used when ingesting from or outputting to tape. This option switches the data range of the signal output by your video capture card, but only during capture from tape in the Media page, or output to tape in the Deliver page. When capture or output is not currently occurring, your video capture card goes back to using the identically named data range setting in the Master Settings panel of the Project Settings, which governs how you monitor the signal being output on an external broadcast display or projector.

– **Video bit depth**: Choose the bit depth that corresponds to the capability of your deck. You can choose between 8-bit and 10-bit. Outputting to 10-bit is more processor intensive, but higher quality for compatible devices, and is the default setting.

– **Use deck autoedit**: If supported by your video deck, this is the best method to record video to the deck, as it enables the deck to roll the edit using the specified preroll, and control the edits via serial device control. If this checkbox is turned off, a basic edit On/Off mode is used by the deck, with the potential for frame inaccuracies if the “Non auto edit timing” setting is not properly adjusted.

– **Non auto edit timing**: Adjusts the edit synchronization of the connected deck when auto edit is turned off.

– **Deck preroll**: Sets the number of seconds for preroll. How much is appropriate depends on the performance of your deck.

– **Video output sync source**: When using a DeckLink card this is set to Auto. Other capture cards may require you to set the sync source to “Reference” for playout and “Input” for ingest. This setting is only available if you have a DVS card installed on your system.

– **Add 3:2 pulldown**: Inserts or removes the 3:2 pulldown required to record or play 23.98 fps media to or from a 29.97 tape format.

### Capture

These settings are used when you use the Capture mode in the Media page to capture clips from tape into the Media Pool. Media is captured as DPX image sequences.

– **Capture**: Lets you choose whether to capture both Video and Audio, or Video Only.

– **Video Format**: The format that scanned film frames are saved as. When capturing from tape, the available options are DPX and QuickTime. When capturing from the Cintel film scanner, this is restricted to Cintel Raw Image (CRI), which is a raw data format that DaVinci Resolve automatically debayers as a Cineon log-encoded image for grading.

– **Codec**: The codec used to write captured media. When capturing from tape, these include the various type of Apple ProRes, 8- and 10-bit YUV 422, 10-bit RGB, and the various types of DNxHD. Cintel Raw Image files default to RGB.

– **Save clips to**: A field that displays the directory path to which media files captured from tape are written. You want to choose a volume that’s fast enough to accommodate the data rate of the media format you’re capturing.

– **Browse**: Click this button to choose a directory to write captured media to. The directory you choose appears in the field above.

– **Save in this folder path**: A series of checkboxes let you specify what other information to use to define the directory hierarchy that will hold the captured media. Every checkbox you turn on adds an additional directory with a name defined by that checkbox’s metadata. You can choose any or all of the following: Program name, Clip number, Reel number, and Roll/Card.

– **Apply reel number to**: Lets you choose how to write the reel name. Two checkboxes let you write the reel number to the file’s name, and/or to the Header data.
– Use prefix: A field lets you type in a prefix to be used in the media file's name. This lets you add text identification that will make the media more easily identifiable and searchable.

– Apply prefix to: Two checkboxes let you choose to use the prefix you typed in the file name, and/or in the folder name.

– Use frame number with: When capturing to image sequences, you can choose how many digits to use when writing the frame number into the name of each frame file.

– Set batch ingest handles to: When capturing to image sequences from a batch list, defines how many frames of additional handles to ingest along with each logged clip.

– Enable audio input: Turn this checkbox on to capture audio along with the video. If you're capturing QuickTime or MXF files, the audio will be written as additional tracks inside each file. If you're capturing to a DPX image sequence, then a broadcast .wav file is recorded separately.

– Input: Lets you choose how many tracks of audio to capture, from 2 to 16.

**Playout Settings**

These settings only affect the video signal that's output when you use the Edit to Tape mode of the Deliver page.

– Output: Lets you choose whether to output both Video and Audio, Video Only, or Audio Only if you're doing an audio layback.

– Output Source Timecode: Turn this checkbox on to output each individual clip's source timecode. This option is only applicable when assemble editing to tape.

– Output LTC: With a Blackmagic Design DeckLink or UltraStudio device using HD-SDI, longitudinal timecode (LTC) is available on track 16 of the HD-SDI video signal, making it easy to use a Mini Converter de-embedder to extract this analog timecode audio signal and feed it directly to a recording device. This is particularly helpful if you have outboard video processing equipment such as a noise reducer or format converter that does not pass through the VITC timecode.

– Delay LTC by x frames: When outputting LTC to bypass outboard processing gear, such as a noise reducer or format converter, you can compensate for the processing delay by delaying the timecode by a matter of frames to ensure that the processed image and timecode reach the deck at the same time. With a DVS card there is a separate timecode output.

– Enable audio output: When this checkbox is enabled, DaVinci Resolve will play all available timeline audio along with the video being output, so both can be recorded to tape.

– Offset audio by x frames: Lets you specify an offset between the audio track and video to achieve proper A/V sync in cases where the video is being delayed by outboard processing hardware.

– Output x channels of audio: Choose the number of audio tracks to output to tape.

– Set batch playout head handle to x seconds: When batch outputting multiple clips, you can specify a number of frames before the In point of each clip to be output as well.

– Set batch playout tail handle to x seconds: When batch outputting multiple clips, you can specify a number of frames after the Out point of each clip to be output as well.

– Apply gaps between clips: This checkbox lets you add a black gap, of the specified duration in frames, between every two clips being output when outputting in batch mode.

**Edit to Tape Queue Option Menu Settings**

The following settings and options are available in the Option menu found at the top right-hand corner of the Edit to Tape Queue.
– **Show Job Details:** Lets you see more information about each job listed in the Render Queue.
– **Clear Recorded:** Clears all queue items that have already been output to tape.
– **Clear All:** Clears every queue item.
– **Sort by Reel & Timecode:** Does a multi-criteria sort by reel and timecode, reel first, then timecode.
– **Sort by Timecode:** Sorts by timecode only.
– **Output Source Timecode:** Sets tape output to write source timecode to tape (each clip’s individual timecode), rather than record timecode (from the Timeline).
– **Use Preview for Tape Output:** Enables Preview mode when outputting to tape. Preview mode lets you test how an edit to tape operation will work before actually recording it.

### Tape Output Procedures

There are a few different ways you can output media to tape, depending on what you need to accomplish, and on how intensive your grades are relative to the processing capabilities of your workstation.

#### Power Mastering

Power Mastering allows you to select either a range of clips, or an entire timeline, to be output to tape in real time, without rendering. This can save you from a time-consuming render, and it also saves disk space. Power Mastering is a no-compromise procedure, since your program is still output at full quality.

If there are a handful of clips with grades that you know are too processor-intensive to be Power Mastered, you can use the Render Cache controls to cache the problem clips before output. For more information, see Chapter 7, “Improving Performance, Proxies, and the Render Cache.”

#### Outputting a Program From the Timeline

The simplest method of outputting to tape is to output a single Timeline, either in its entirety, or in part if you’re insert editing a small section that has been revised.

**To Power Master to tape:**

1. Use the Render Cache, if necessary, to cache any clips that are too processor-intensive to output in real time.
2. Click the Edit to Tape mode button to the left of the transport controls to switch to tape output.
3. Define how much of the current Timeline to output by moving the playhead throughout the program, and then right-clicking clips that define the beginning and end of the range you need to output and using the Mark In and Mark Out commands.
4. Use the transport controls to find the In point on tape at which you want to start recording, and click the In button.
5. Choose Insert from the drop-down menu at the upper right-hand side of the Viewer, if you’re either outputting to a striped and blacked tape, or inserting over an existing program on tape.
6. Click the Power Mastering (lightning bolt) button at the bottom of the tape settings to add the job you’ve just set up to the Edit to Tape Queue.
7. Click Start Record to begin the process of outputting to tape. Device control is used to record to the designated section of tape; a progress bar appears at the bottom of the Render Queue to show how long this will take.
If you don’t want to Power Master, you can render the section of the Timeline you need to output as a single clip first, as a self-contained media file, and then add that clip directly to the Edit to Tape Queue. This might be an easier solution if you’re outputting an extremely processor-intensive timeline.

**To output a pre-rendered media file to tape:**

1. Click the Add Clips button at the bottom of the tape settings, and use the VTR Record dialog to select the media file you rendered in step 1, and click Add Clip(s) to Queue.
   
   The media file you selected is added to the Edit to Tape Queue as a Power Mastering job, and will be output in its entirety.

2. Use the transport controls to find the In point on the tape at which you want to start recording, and click the In button.

3. Choose Insert from the drop-down menu at the upper right-hand side of the Viewer, if you’re either outputting to a striped and blacked tape, or inserting over an existing program on tape.

4. To preview what the edit will look like before actually writing it to tape, choose “Use Preview for Tape Output” from the Edit to Tape queue option-menu, and then click Start Record to watch DaVinci Resolve run through the edit using the deck. After previewing the edit, turn this setting off.

5. Click Start Record to begin the process of outputting to tape. Device control is used to record to the designated section of tape; a progress bar appears at the bottom of the Render Queue to show how long this will take.

**Batch Outputting Multiple Clips**

You also have the option of outputting a number of clips to tape in a batch operation, as opposed to outputting from the Timeline. When you set up a batch of multiple clips in the Edit to Tape Queue, then DaVinci Resolve will automatically record them sequentially to tape.

How the timecode is generated during batch output depends on the “Output Source Timecode” setting in the Capture and Playback panel of the Project Settings. If this is turned off, then a continuous timecode track will be written to cover everything being output to tape. If this is turned on, then each clip’s source timecode will be written to tape discontinuously.

When batch outputting to tape, you can add black handles to each of the clips to space them out, making later ingest easier, using the “Set batch playout head/tail handle” settings in the Capture and Playback panel of the Project Settings.

**To make a Batch Record multiple clips to tape:**

1. Use the transport controls to find the In point on tape at which you want to start recording, and click the In button.

2. Do one of the following to add items to output to the Edit to Tape Queue:
   
   – Click the Add Clips button at the bottom of the tape settings, and choose one or more media files from the VTR Record browser, and click Add Clip(s) to Queue.
   
   – Right-click any clip in the Timeline, choose Render This Clip, and then click the Power Mastering button at the bottom of the tape settings to add that clip to the Queue.

3. Choose either Assemble or Crash from the drop-down menu at the upper right-hand side of the Viewer. Because you’re outputting clips with discontinuous timecode, you cannot insert edit when batch outputting.

4. Once you’ve added all the clips you want to output to the queue, click Start Record to begin outputting to tape. Device control is used to record to the designated section of tape; a progress bar appears at the bottom of the Render Queue to show how long this will take.
Exporting Timelines and Metadata

Once you’ve completed editing and grading a program, you may need to export your final graded timeline as EDL, AAF, or XML files in order to send it to another application for further finishing, effects work, or to complete a round trip from an NLE.

To send a graded project to another application, you need to render the graded clips first using the controls on the Deliver page to render the Timeline as individual source clips. In this mode, the reel name and timecode metadata of each rendered clip is mirrored by the exported project file, to maintain the correlation between exported EDL, XML, or AAF data and the rendered media. For detailed information about rendering in the Deliver page, see Chapter 186, “Rendering Media.”

If you render using the Easy Setups that correspond to Final Cut Pro XML or Avid AAF round trips, then an XML or AAF will be exported to the same directory you’ve rendered to. However, you can still export an XML, AAF, or EDL file separately should the need arise.

Alternately, if you’ve edited a project from scratch in DaVinci Resolve and need to move a timeline to another application, you can export any timeline to any format for purposes of project exchange, without the need to render new media (depending on your workflow).

Even in situations where you’ve imported a timeline from another application, the robust project compatibility of DaVinci Resolve makes it possible to import one type of project exchange file, such as XML, and then export a completely different kind, such as AAF or EDL. This lets you use DaVinci Resolve as a project exchange utility.
Exporting to AAF/XML

Whether you’ve edited your project from scratch inside of DaVinci Resolve, or you’re doing a round trip with an application that uses AAF, Final Cut Pro 7 XML, or Final Cut X XML project exchange formats, you can export any DaVinci Resolve timeline in the Edit page to any project format DaVinci Resolve supports. Whatever your workflow, keep the following in mind:

– **Timelines are automatically exported when you render a timeline in the Deliver page:** When you use the “Final Cut Pro Round-Trip” or “Avid AAF Round-Trip” render setting presets, or a preset created from one of them, a corresponding XML or AAF file is automatically exported along with the media you render.

– **Even if you’ve imported a project from another application, you can re-edit imported projects before export:** If necessary, you can freely re-edit projects you’re planning to export. When you export an AAF or XML file, the Timeline will be sent back to the originating NLE, or onward to the finishing application of choice.

– **Unsupported effects are sometimes preserved in Round Trip workflows:** If there were effects or clip constructs in the original sequence that were not compatible with DaVinci Resolve, how those effects will be handled depends on the project format you’re exporting to, and whether or not you’ve edited the project. For XML projects, unsupported effects are saved internally by DaVinci Resolve, and are exported with the XML file that you output no matter what. Consequently, they should reappear when you reopen the exported file in the originating NLE. For AAF projects, you can export unsupported effects as long as you don’t re-edit the project. However, if you do re-edit the project, then you can only export an AAF file that’s been stripped of all unsupported effects.

– **Project formats can be converted to other formats:** Using DaVinci’s Export commands, compatible project formats can be converted from one format to another. For example, an imported EDL can be output as Final Cut Pro X XML. For that matter, Final Cut Pro 7 XML can be imported and then exported as Final Cut X XML. Or, an AAF file from Media Composer can be imported and then exported as a Final Cut Pro XML file to be opened in any NLE or finishing application compatible with that format, such as Premiere Pro or Smoke.
To export an AAF or XML file after you’ve rendered the graded clips:

Do one of the following:

1. To export the current Timeline, choose File > Export AAF, XML, or press Shift-Command-O.
   - Open the Edit page, right-click the Timeline you want to export in the Media Pool, and choose Timelines > Export > AAF/XML.
   - When the Export XML dialog appears, type a name for the file and choose a location for the exported XML file, then click Save.

2. An XML version of that timeline is saved, complete with references to the graded media you rendered, and is ready for import into an NLE or finishing application.

More About Exporting to AAF

When you export to AAF, there are actually two options that are available to you, depending on whether you made editorial changes to the Timeline in the Edit page:

- If you didn’t make any editing changes to the Timeline you imported: You can choose File > Export AAF, XML, and choose “AAF Files” from the Format drop-down menu. This exports all audio and effects using data from the original AAF file that was exported from Media Composer, regardless of whether or not they’re supported in DaVinci Resolve. When you export an unedited AAF, DaVinci Resolve uses the Avid AAF file that you originally imported to create an updated one; make sure it’s still in the same location as it was when you first imported it into DaVinci Resolve.

- If you made editing changes to the Timeline you imported, or you’re exporting a project that wasn’t AAF to begin with: Then you need to right-click the Timeline you want to export in the Media Pool and choose Timelines > Export > Generate New AAF. This option creates a brand new AAF file, but audio and effects that are not supported in DaVinci Resolve in an AAF import are discarded.

Exporting an EDL

DaVinci Resolve is also capable of exporting EDLs that can be reimported into other applications. For more information about EDL workflows, see Chapter 23, “Ingesting From Tape,” Chapter 57, “Conforming and Relinking Clips,” and Chapter 61, “Conforming EDL Files.”

To export an EDL:

1. Open the Edit page and select the Timeline you want to export an EDL from in the Media Pool.

2. Exported EDLs only have a single video track. For timelines with multiple tracks, only the events on the video track with the destination control assigned to it will be exported (the destination control is the first control at the left in the track header). If you want to export a track other than Video 1, you can assign the destination control to the specific track you need to export.

3. Right-click the Timeline in the Media Pool, and choose Timelines > Export > AAF/XML/EDL from the contextual menu.

4. When the Export Timeline dialog appears, type a name, choose a location for the exported EDL, and choose EDL Files from the drop-down menu at the bottom, then click Save. An EDL is exported.
Exporting a Missing Clips EDL

This command lets you export a quick report listing all clips that are offline in the currently selected track of the Timeline in the Edit page. This report is in EDL format, with one event for each clip that’s offline, which describes the reel number and source timecode of the missing media, as well as the record timecode of the missing media’s position on the Timeline.

Here’s an example of an exported Missing Clips EDL:

<table>
<thead>
<tr>
<th>TITLE: ( no title )</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 A001_C002_0820GA_001 V C 10:28:27:03 10:28:28:00 01:00:00:00 01:00:00:21</td>
</tr>
<tr>
<td>2 A004_C012_0820MC_001 V C 14:07:31:21 14:07:35:13 01:00:12:13 01:00:16:05</td>
</tr>
<tr>
<td>3 A017_C001_0820CV_001 V C 21:16:14:22 21:16:15:00 01:00:16:05 01:00:16:07</td>
</tr>
</tbody>
</table>

Once you’ve exported this information, you can hand it off to whomever can help you track down the missing media.

To export a Missing Clips EDL:

1. Open the Edit page and open the Timeline you want to export a Missing Clips EDL for in the Timeline browser.
2. For timelines with multiple tracks, only the events on the video track with the destination control assigned to it will be examined for missing clips. If you want to examine a track other than Video 1, you can assign the destination control to the specific track you need to examine for missing clips.
3. Right-click the Timeline in the Media Pool, and choose Timelines > Export > Missing Clips EDL from the contextual menu.
4. When the Save Missing Clips EDL dialog appears, type a name and choose a location for the exported EDL, then click Save.

Exporting Timeline Markers to EDL

If you keep notes about a project within the notes field of Timeline markers, found in the Timeline ruler, then it’s possible to export those notes as an EDL.

To export timeline markers as an EDL:

1. Right-click that timeline in the Media Pool, and choose Timelines > Export > Timeline Markers to EDL.
2. Choose a location and export format from the Export Edit Index dialog, and click Save. Each Timeline marker is listed in the resulting EDL, with any notes included along with a duration, where applicable.
Exporting to CDL

DaVinci Resolve can export and import basic grading data to and from other applications via a Color Decision List (CDL). CDLs are an industry-standard file format originally developed by the American Society of Cinematographers’ technology committee. DaVinci Resolve supports the 1.2 CDL standard that defines the slope, offset, and power for each of the red, green, and blue channels, as well as the overall saturation of each clip in a program.

CDL files are formatted similarly to EDLs, with SOP (Slope/Offset/Power), and SAT (Saturation) values embedded as metadata in much the same way as comments are in a more typical EDL.

Here’s an example of a single CDL event:

```
020 001 V C 03:02:49:13 03:02:53:00 01:01:28:11 01:01:31:22
*ASC_SOP (1.109563 1.717648 0.866061)(-0.238880 -0.390357 0.353743)
(0.672948 1.384022 0.889876)
*ASC_SAT 1.000000
```

Because the CDL definition of a grade is so narrow, projects you’re planning to export to other applications via a CDL must be constrained to only those operations the CDL mathematically defines. Here are some things to keep in mind:

- Only primary corrections in the first node of each clip are exported.
- Restrict yourself to using the Lift/Gamma/Gain, Offset, and Saturation controls.
- Keyframes are never exported. If keyframes are present in a grade, only the parameter values at the first frame of the clip are used.
- The track grade and group grades are completely ignored.
- If there is an HSL Qualifier or a Power Window in the first node, it is ignored and the corrections in that node are exported as if it were a primary correction.
- Do not make Y’ only adjustments; they’re not compatible with CDLs. To ensure that your exported CDL is accurate, set the Lum Mix parameter in the Primary Controls palette for each grade to 0. For workflows involving frequent CDL export, you can turn on the “Luminance Mixer defaults to zero” option in the Color section of the General Options panel of the Project Settings to guarantee this parameter is always set to 0.

If your timeline conforms to all of these restrictions, then you’re ready to export a CDL.

To export a CDL:

1. Open the Edit page, right-click the Timeline you want to export in the Media Pool, and choose Timelines > Export > CDL from the contextual menu.
2. Enter a name for the CDL, choose a location to save it to, and click OK.

For more information on importing a CDL to add grades to your project, see Chapter 146, “Copying and Importing Grades Using ColorTrace.”
Exporting the Edit Index as a CSV or TXT File

You can export the current contents of the Edit Index, in the Edit page, as a self-contained file to use for reference in a variety of ways.

To export the Edit Index:

1. Open the Edit Index, and choose one of the Edit Index filters from the Edit Index option menu, if necessary. For example, you could filter the edit index by Offline Clips Only if you wanted to export a list of all offline clips in the current timeline.

2. Right-click that timeline in the Media Pool, and choose Timelines > Export > Edit Index, then choose a location and export format from the Export Edit Index dialog, and click Save.

Exporting to ALE

DaVinci Resolve is also capable of exporting ALE (Avid Log Exchange) files. ALE is a tab-delimited, ASCII text-based clip logging list format that enables the exchange of clip metadata that can’t be embedded inside MXF files. ALE files are designed to let you export a log of all clips that are used in a particular timeline with all of the metadata that’s associated with those clips in DaVinci Resolve, so this metadata can be imported into and associated with clips inside Media Composer or Symphony.

ALE files are divided into three sections, labeled Heading, Column, and Data:

- The Heading provides information about the clips being logged, including the picture and audio format, and the frame rate.
- The Column line defines each of the columns of metadata being exported in the list. There’s an automatic minimum of metadata columns that are automatically included, regardless of whether they’re populated or not. However, additional metadata columns are automatically added to this list by DaVinci Resolve when any corresponding metadata field in the Metadata Editor is populated. For example, if you enter information into the Camera, Keyword, and Shot fields of the Metadata Editor, then those columns will be added to the exported ALE. There are no user settings that control this.
- The Data section contains multiple lines, one for each event being referenced in the list, that contain all the data corresponding to that clip.

If you’re exporting stereoscopic clips from stereoscopic timelines, the following additional columns of metadata are automatically included in the two ALE files that are generated:

- Pan (relative to timeline resolution)
- Tilt (relative to timeline resolution)
- Zoom
- Rotate
- Convergence (relative to timeline resolution)
- HFlip (0 or 1)
- VFlip (0 or 1)

If you’re exporting ALE files from projects using ARRIRAW clips, the following additional columns of metadata can be included:

- Temperature
- Tint
To export an ALE file:

1. Open the Edit page, right-click the Timeline you want to export in the Media Pool, and choose Timelines > Export > ALE from the contextual menu.

2. Enter a name for the ALE file, choose a location to save it to, and click OK.

The ALE file is saved, and a dialog appears reminding you of the file path to which it was saved (click OK to dismiss it).

Here's an example of a short ALE export:

<table>
<thead>
<tr>
<th>Heading</th>
</tr>
</thead>
<tbody>
<tr>
<td>FIELD_DELIM</td>
</tr>
<tr>
<td>VIDEO_FORMAT</td>
</tr>
<tr>
<td>AUDIO_FORMAT</td>
</tr>
<tr>
<td>FPS</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name, Tracks, Start, End, Take, Tape, UNC, FPS, Reel, Scene, Shoot, date, Manufacturer, Source Resolution, Source, Bit Depth, DESCRIPT, Comments, Audio SR, Audio Bit Depth, Auxiliary TC1, KN Start, Source File Path, Display Name</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>A001_C002_V01.CBF6A4FD139AD.mxf, V, 10:28:27:03, 10:28:28:00, A001_C002_V01.CBF6A4FD139AD</td>
</tr>
<tr>
<td>/Volumes/Disk_1/Avid MediaFiles/MXF/1/A001_C002_V01.CBF6A4FD139AD.mxf</td>
</tr>
<tr>
<td>23.98, DaVinci Resolve, 1920x1080, 10</td>
</tr>
<tr>
<td>/Volumes/Disk_1/Avid MediaFiles/MXF/1/A001_C002_V01.CBF6A4FD139AD.mxf</td>
</tr>
<tr>
<td>A001_C002_V01.CBF6A4FD139AD</td>
</tr>
<tr>
<td>A016_C008_V01.CBF6A4FD13ABD.mxf,V, 23:35:56:03, 23:36:00:11, A016_C008_V01.CBF6A4FD13ABD</td>
</tr>
<tr>
<td>/Volumes/Disk_1/Avid MediaFiles/MXF/1/A016_C008_V01.CBF6A4FD13ABD.mxf</td>
</tr>
<tr>
<td>23.98, DaVinci Resolve, 1920x1080, 10</td>
</tr>
<tr>
<td>/Volumes/Disk_1/Avid MediaFiles/MXF/1/A016_C008_V01.CBF6A4FD13ABD.mxf</td>
</tr>
<tr>
<td>A016_C008_V01.CBF6A4FD13ABD</td>
</tr>
<tr>
<td>A004_C012_V01.CBF6A4FD1438E.mxf, V, 14:07:31:21, 14:07:35:15, A004_C012_V01.CBF6A4FD1438E</td>
</tr>
<tr>
<td>/Volumes/Disk_1/Avid MediaFiles/MXF/1/A004_C012_V01.CBF6A4FD1438E.mxf</td>
</tr>
<tr>
<td>23.98, DaVinci Resolve, 1920x1080, 10</td>
</tr>
<tr>
<td>/Volumes/Disk_1/Avid MediaFiles/MXF/1/A004_C012_V01.CBF6A4FD1438E.mxf</td>
</tr>
</tbody>
</table>

**NOTE:** The commas shown above are not normally in the ALE but shown here for field clarity.
Exporting to ALE with CDL

Avid Media Composer and Symphony also support the import of ALE files with additional CDL metadata columns with which to associate SOP (Slope/Offset/Power) and SAT (Saturation) adjustment metadata to each clip that's logged in the ALE.

When you import an ALE with CDL file into Media Composer, the SOP and SAT data populate metadata columns for preservation and export in various Avid workflows. Here's an example of the Heading, Column, and Data sections of a sample ALE with CDL, with one line of clip and CDL data.

To export an ALE with CDL file:

1. Open the Edit page, right-click the Timeline you want to export in the Media Pool, and choose Timelines > Export > ALE and CDL from the contextual menu.
2. Enter a name for the ALE file, choose a location to save it to, and click OK.
   
   The ALE file is saved, and a dialog appears reminding you of the file path to which it was saved (click OK to dismiss it).

Here's an example of a short ALE with CDL export:

<table>
<thead>
<tr>
<th>Heading</th>
<th>Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>FIELD_DELIM</td>
<td>TABS</td>
</tr>
<tr>
<td>VIDEO_FORMAT</td>
<td>1080</td>
</tr>
<tr>
<td>AUDIO_FORMAT</td>
<td>—</td>
</tr>
<tr>
<td>FPS</td>
<td>23.976</td>
</tr>
</tbody>
</table>

| Name, Tracks, Start, End, Take, Tape, UNC, FPS, Reel, Scene, Shoot date, Manufacturer, Source Resolution, Source Bit Depth, DESCRIPT, Comments, Audio SR, Audio Bit Depth, Auxiliary TC1, KN Start, Source File Path, Display Name KeyKode, ASC_SOP, ASC_SAT, RESOLVE_SIZING |
|-----------------------------------------------|------------------------------------------------------------------------|
| A001_C002_V01.CBF6A4FD139AD.mxf, V, 10:28:27:03, 10:28:28:00, A001_C002_V01.CBF6A4FD139AD  | 23.98, DaVinci Resolve, 1920x1080, 10                                   |
| /Volumes/Disk_1/Avid MediaFiles/MXF/1/A001_C002_V01.CBF6A4FD139AD.mxf                    |                                                          |
| A001_C002_V01.CBF6A4FD139AD                                                               |

(1.0260, 1.0260, 1.0260) (-0.0260, -0.0260, -0.0260) (0.8237, 0.8237, 0.8237) 0.8640 (0.0000, 0.0000, 1.0000, 0.0000, 0.0000, 0.0000, 0.0000, 0.0000, 0.0000, 0.0000)

**NOTE:** The commas shown above are not normally in the ALE but shown here for field clarity.
Exporting Timeline Markers to EDL

This command lets you export a quick report listing the text of all markers that have been added to the Timeline as notes in an EDL. Clip markers are ignored. This report is in EDL format, with one event for each Timeline marker, with a placeholder reel number (001 by default), and source and record timecodes that correspond to each marker’s position in the Timeline (with a duration of one frame). An EDL note for each event lists the Marker note, if there is one. There is no note available for the color of the markers.

Here’s an example of an exported Timeline Marker EDL:

TITLE: ( no title )
001  001  V  C  01:00:09:09 01:00:09:10 01:00:09:09 01:00:09:10
Replace with another car door sound effect
002  001  V  C  01:00:20:12 01:00:20:13 01:00:20:12 01:00:20:13
Trim this clip shorter
003  001  V  C  01:00:30:12 01:00:30:13 01:00:30:12 01:00:30:13
Find another stock footage clip of the bridge
004  001  V  C  01:00:30:13 01:00:30:14 01:00:30:13 01:00:30:14
Trim this montage three seconds shorter

Exporting and Importing Media Pool Metadata

DaVinci Resolve makes it possible to export metadata from the Media Pool of one project for import into the clips of another project, for instances where you need to move metadata around. This process exports all metadata from the Media Pool as a .csv file.

For example, a DIT might have entered a lot of metadata to the DaVinci Resolve project used for generating dailies, but then an impatient editor might have created a separate project to begin editing those dailies. Instead of requiring the editor to enter each clip’s metadata all over again, you can export the metadata from the DIT’s project and import it into the editor’s new project, automatically matching the relevant metadata to each corresponding clip.

To export Media Pool metadata:
1. Open a project containing Media Pool metadata you want to export.
2. Optionally, select which clips in the Media Pool you want to export metadata for.
3. Choose File > Export Metadata From > Media Pool to export metadata from every clip in the Media Pool, or choose File > Export Metadata From > Selected Clips to only export metadata from clips you selected in step 2.
4. When the Export Metadata dialog appears, enter a name and choose a location for the file to be written, then click Save. All metadata is exported into a .csv file that can be viewed and/or edited in any spreadsheet application.

To import Media Pool metadata:
1. Open a project containing clips you want to populate with imported metadata.
2. Optionally, select which clips in the Media Pool you want to import metadata to.
Choose File > Import Metadata To > Media Pool to import metadata to potentially every clip in the Media Pool, or choose File > Import Metadata To > Selected Clips to only import metadata to clips you selected in step 2.

When the Import Metadata dialog appears, choose a metadata .csv file to import, and click Open.

When the Metadata Import dialog appears, choose the Import Options you want to use to match the .csv file’s metadata to the correct clips in the currently open project. By default, DaVinci Resolve tries to use “Match using filename” and “Match using clip start and end Timecode” to match each line of metadata in the .csv file with a clip in the Media Pool, but there are other options you can use such as ignoring file extensions, using Reel Name, and using source file paths.

Next, choose which Merge Option you want to use in the Metadata Import dialog. There are three options:

- **Only update metadata items with entries in the source file**: The default setting. Only updates a clip’s metadata if there’s a valid entry in the imported .csv file. Other clip metadata fields are left as they were before the import.

- **Update all metadata fields available in the source file**: For each clip that corresponds to a line of metadata in the imported .csv file, every single metadata field referenced by the .csv file is overwritten, regardless of whether or not there’s a valid entry for that field.

- **Update all metadata fields available in the source file and clear others**: For each clip that corresponds to a line of metadata in the imported .csv file, every single metadata field referenced by the .csv file is overwritten, regardless of whether or not there’s a valid entry for that field. Furthermore, metadata fields that aren’t referenced by the imported .csv file are cleared of whatever metadata was there before.

The Metadata Import dialog that lets you choose options for how to match and merge imported metadata

When you’re finished choosing options, click Ok and all available metadata from the source .csv file will be imported.
Advanced Workflows
Chapter 190

Workflow Integrations

This chapter describes third party Workflow Integration and Codec plug-ins for DaVinci Resolve.

Contents

Workflow Integrations in DaVinci Resolve (Studio Version Only) 3562
Creating Workflow Integration Plugins 3562
Workflow Integration Plugins 3562
EditShare 3562
Studio Network Solutions (SNS) 3563
Codec Plug-ins (Studio Version Only) 3563
MainConcept 3563
Workflow Integrations in DaVinci Resolve
(Studio Version Only)

DaVinci Resolve allows third parties to create their own custom interface plug-ins using scripting languages. This makes possible a direct integration between DaVinci Resolve and other software programs, for a variety of uses. More than one Integration plug-in can be active at the same time. After installation, plug-ins can be enabled in DaVinci Resolve by going to Workspace > Workflow Integrations, and selecting your plug-in from the drop-down menu.

Creating Workflow Integration Plugins

Users can write their own Workflow Integration Plugin (an Electron app), using Resolve Javascript’s API, and Python or Lua scripts. For more information on how to create a Workflow Integration Plugin go to Help > Documentation > Developer, and open up the Workflow Integrations folder for technical details and sample code.

Workflow Integration Plugins

There are several Media Asset Management (MAM) systems that can now directly be accessed through DaVinci Resolve using the Workflow Integration Plugins.

EditShare

EditShare has created a workflow integration plug-in that allows DaVinci Resolve to interface directly with their FLOW media management system. This plug-in allows you to comment, search, and preview media in FLOW without leaving DaVinci Resolve. You can also upload revisions, manage proxy media, and maintain full metadata support throughout the process.

For more information on this plug-in and how FLOW works with DaVinci Resolve go to: https://editshare.com/say-hello-to-flow-and-davinci-resolve-studio/
Studio Network Solutions (SNS)

Studio Network Solutions (SNS) created the ShareBrowser Integration Plugin to interface between DaVinci Resolve and their ShareBrowser media asset management software, included with SNS EVO media servers. This plug-in allows your team to search, tag, preview, comment, organize, and import media without leaving the DaVinci Resolve interface. Your team can directly import the media into a DaVinci Resolve project and the metadata you entered carries over along with the media.

For more information on this plug-in and how SNS's high-speed server or cloud solutions work with DaVinci Resolve, go to: https://www.studionetworksolutions.com/.

Codec Plug-ins (Studio Version Only)

Codec plug-ins allow third parties to install new codecs for encoding in the Deliver page that are not currently supported in the main DaVinci Resolve software. This opens the door for extremely specific deliverables that would normally require passes through multiple programs to deliver.

MainConcept

The MainConcept Codec Plugin allows you to render your DaVinci Resolve Studio timelines in a variety of new codecs:

- AS-11 UK SD, AS-11 UK HD along with an included XML metadata file to create AS-11 UK DPP compliant content.
- MainConcept’s software HEVC Main and Main 10 profiles, allowing H.265 files in 8-bit/10-bit 4:2:0/4:2:2 at up to 8K resolution.
- MainConcept MXF and MP4, allowing encoding into the native camera formats used by Sony XAVC/XDCAM and Panasonic P2 AVC based cameras.
More information on the MainConcept Codec Plugin for DaVinci Resolve can be found here: https://www.mainconcept.com/blackmagic-plugins

The MainConcept Codec Plugin for DaVinci Resolve options in the Deliver page.
Chapter 191

Creating DCTL LUTs

This chapter describes how to create DCTL LUTs to perform your own custom mathematical transformations in DaVinci Resolve.

Contents

About DCTL 3566
DCTL Syntax 3566
A Simple DCT LUT Example 3568
A Matrix DCT LUT Example 3568
A More Complex DCT LUT Example 3569
About DCTL

DCTL files are actually color transformation scripts that DaVinci Resolve sees and applies just like any other LUT. Unlike other LUTs, which are 1D or 3D lookup tables of values that approximate image transformations using interpolation, DCTL files are actually comprised of computer code that directly transforms images using combinations of math functions that you devise. Additionally, DCTL files run natively on the GPU of your workstation, so they can be fast.

Anyone with the mathematical know-how can make and install a DCTL. Simply enter your transformation code, using a syntax that’s similar to C (described in more detail below), into any text editor capable of saving a plain ASCII text file, and make sure its name ends with the “.dctl” (DaVinci Color Transform Language) file extension. Once that’s done, move the file to the LUT directory of your workstation. Where that is depends on which OS you’re using:

– **On Mac OS X**: Library/Application Support/Blackmagic Design/DaVinci Resolve/LUT/
– **On Windows**: C:\ProgramData\Blackmagic Design\DaVinci Resolve\Support\LUT
– **On Linux**: /home/resolve/LUT

When DaVinci Resolve starts up, assuming the syntax of your .dctl is correct, they appear in the Color page Node contextual menu within the DaVinci CTL submenu.

DCTL Syntax

Users need to put __DEVICE__ in front of each function they write. For example:

```
__DEVICE__ float2 DoSomething()
```

The main entry function (transform) should come after all other functions, with the following format argument:

```
__DEVICE__ float3 transform(float p_R, float p_G, float p_B)
```

The main entry function must also have a float3 return value.

For the following floating point math functions, please use the described syntax:

- `float _fabs(float)` // Absolute Value
- `float _powf(float x, float y)` // Compute x to the power of y
- `float _logf(float)` // Natural logarithm
- `float _log2f(float)` // Base 2 logarithm
- `float _log10f(float)` // Base 10 logarithm
- `float _exp2f(float)` // Exponential base 2
- `float _expf(float)` // Exponential base E
- `float _copysignf(float x, float y)` // Return x with sign changed to sign y
- `float _fmaxf(float x, float y)` // Return y if x < y
- `float _fminf(float x, float y)` // Return y if x > y
- `float _saturatef(float x, float minVal, float maxVal)` // Return min(max(x, minVal), maxVal)
- `float _sqrtf(float)` // Square root
- `int _ceil(float)` // Round to integer toward + infinity
int _floor(float)  // Round to integer toward - infinity
float _fmod(float x, float y)  // Modulus. Returns x - y * trunc(x / y)
float _fremainder(float x, float y)  // Floating point remainder
int _round(float x)  // Integral value nearest to x rounding
float _hypotf(float x, float y)  // Square root of (x^2 + y^2)
float _atan2f(float x)  // Arc tangent of (y / x)
float _sinf(float x)  // Sine
float _cosf(float x)  // Cosine
float _acosf(float x)  // Arc cosine
float _asinf(float x)  // Arc sine
float _fdivide(float x, float y)  // Return (x / y)
float _frecip(float x)  // Return (1 / x)

The following functions support integer type:
min, max, abs, rotate

Other supported C Math functions include:
acosh, acospi, asinh, asinpi, atan, atanah, atanpi, atan2pi, cbnt, coss, cosp, exp10, expml, trunc, fdiw, fabma, lgamma, log1p, logb, rint, round, rsqrt,
sincos, sinh, sinpi, tan, tanh, tanpi, tgamma

Vector types float2, float3, and float4 are supported. The data fields are:
float x
float y
float z
float w

To generate a vector value, use make_floatN() where N = 2, 3, or 4.
Users can define their own structure using "typedef struct." For example:

typedef struct
{
    float c00, c01, c02;
    float c10, c11, c12;
} Matrix;

To declare constant memory, use __CONSTANT__. For example:
__CONSTANT__ float NORM[] = {1.0f / 3.0f, 1.0f / 3.0f, 1.0f / 3.0f};

To pass the constant memory as a function argument, use the __CONSTANTREF__ qualifier, e.g.:
__DEVICE__ float DoSomething(__CONSTANTREF__ float* p_Params)

A float value must have the ‘f’ character at the end (e.g. 1.2f).
A Simple DCT LUT Example

The following code shows an example of how to create a simple color gain transformation using the 
DCT LUT syntax.

// Example to demonstrate simple color gain transformation
__DEVICE__ float3 transform(float p_R, float p_G, float p_B)
{
    const float r = p_R * 1.2f;
    const float g = p_G * 1.1f;
    const float b = p_B * 1.2f;
    return make_float3(r, g, b);
}

A Matrix DCT LUT Example

The following code shows an example of creating a matrix transform using the DCT LUT syntax.

// Example to demonstrate the usage of user defined matrix type to transform RGB to YUV in Rec. 709

__CONSTANT__ float RGBToYUVMat[9] = { 0.2126f, 0.7152f, 0.0722f,
                                      -0.09991f, -0.33609f, 0.436f,
                                      0.615f, -0.55861f, -0.05639f }; 

__DEVICE__ float3 transform(int p_Width, int p_Height, int p_X, int p_Y,
float p_R, float p_G, float p_B)
{
    float3 result;

    result.x = RGBToYUVMat[0] * p_R + RGBToYUVMat[1] * p_G + RGBToYUVMat[2] * p_B;

    return result;
}
A More Complex DCT LUT Example

The following code shows an example of creating a mirror effect, illustrating how you can access pixels spatially.

```cpp
// Example of spatial access for mirror effect

__DEVICE__ float3 transform(int p_Width, int p_Height, int p_X, int p_Y, __TEXTURE__ p_TexR, __TEXTURE__ p_TexG, __TEXTURE__ p_TexB)
{
    const bool isMirror = (p_X < (p_Width / 2));
    const float r = (isMirror) ? _tex2D(p_TexR, p_X, p_Y) : _tex2D(p_TexR, p_Width - 1 - p_X, p_Y);
    const float g = (isMirror) ? _tex2D(p_TexG, p_X, p_Y) : _tex2D(p_TexG, p_Width - 1 - p_X, p_Y);
    const float b = (isMirror) ? _tex2D(p_TexB, p_X, p_Y) : _tex2D(p_TexB, p_Width - 1 - p_X, p_Y);
    return make_float3(r, g, b);
}
```
This chapter describes how to create third-party utilities that use Transport Control with DaVinci Resolve.

Contents

About the TCP Protocol Version 1.2 3571
Data Types 3571
Command Format 3571
Response Format 3571
Communication Delays 3571
Status Response Values 3571
TCP Protocol Stream 3572
connect 3572
goto 3572
play 3572
gettc 3572
getframerate 3572
Sample Code 3572
About the TCP Protocol Version 1.2

This protocol defines the communication standard between third-party applications ("Client") and DaVinci Resolve ("Server") using the TCP protocol.

Port number 9060 will be used by the server. SSL will not be used in this protocol. Communication takes the form of request-response messages, where the Client initiates a command, and the Server responds appropriately.

To use this protocol, you must first type the following string into the Advanced panel of the DaVinci Resolve System Preferences:

System.Remote.Control = 1

Data Types

The following data types are used in this protocol:

- **float (f):** A 4-byte IEEE 754 single precision float
- **int (i):** A 4-bytes signed int
- **unsigned char (uc):** A 1-byte unsigned char (0–255)
- **string (s):** A UTF-8 encoded string. No terminator is specified. The string is a composite type, transmitted as a single int (i) specifying the number of characters in the string (N), followed by N unsigned chars (uc) containing the letters of the string.

**NOTE:** The bytes of the float and int types are transmitted in little endian order.

Command Format

Commands are transmitted as a single string (using characters a–z (0x61 – 0x7A) only), followed by any additional payload required by the command in the definition.

Response Format

The response to any command is composed of a status byte (unsigned char), followed by any additional payload required by the response.

Communication Delays

Once the first byte of the command string is sent, the rest of the command string and the payload data must follow without delay. At the end of COMMAND, the server must respond immediately. If there is a delay of more than 5 seconds during this process, the party waiting for data may drop the connection assuming that the peer has become unresponsive.

There is currently no limit on the delay between two consecutive commands. (NOTE: Alternatively, a maximum allowable delay may be defined, in which case, the client may issue periodic ‘connect’ commands to keep the connection alive.)
Status Response Values
The meaning of the status values are as follows:

- **0x00**: Command was executed successfully. Any additional payload is sent as expected.
- **0xFF**: Command could not be executed successfully. No additional payload will follow.

TCP Protocol Stream
The following commands can be sent over the protocol stream.

**connect**
The client initiates the stream by sending a connect command string. There is no payload. The server responds with a status value of 0x00.

**goto**
The client sends a goto command string followed by four unsigned chars representing the hour, minute, second, and frame of the timecode.

The server responds with an appropriate status byte based on the execution of the command.

**play**
The client sends a play command string followed by a floating point value. Play in real-time is 1.0, stop is 0.0, reverse is -1.0, 2x is 2.0, etc.

The server responds with an appropriate status byte based on the execution of the command.

**gettc**
The client sends a gettc command string.

The server responds with an appropriate status byte (status byte may be 0xFF if no timeline exists, for instance). If the status byte is 0x00, it is followed by four unsigned chars representing the hour, minute, second, and frame of the timecode.

**getframerate**
The client sends a getframerate command string.

The server responds with an appropriate status byte. If the status byte is 0x00, it is followed by a floating point value for the frame rate.

Sample Code
The following C sample program sets up the connection to Resolve, and returns the timeline timecode to the client:

```c
#include <stdio.h>
#include <sys/socket.h>
#include <arpa/inet.h>
#include <unistd.h>
#include <string.h>
# define PORT 9060
```
int main(int argc, char const *argv[]) {
  int sock = 0, valread;
  struct sockaddr_in serv_addr;
  if ((sock = socket(AF_INET, SOCK_STREAM, 0)) < 0) {
    printf("\n Socket creation error \n");
    return -1;
  }

  serv_addr.sin_family = AF_INET;
  serv_addr.sin_port = htons(PORT);

  if(inet_pton(AF_INET, "127.0.0.1", &serv_addr.sin_addr)<=0) {
    printf("\nInvalid address/ Address not supported \n");
    return -1;
  }

  if (connect(sock, (struct sockaddr *)&serv_addr, sizeof(serv_addr)) < 0) {
    printf("\nConnection Failed \n");
    return -1;
  }

  char* connectStr = "connect";
  int length = strlen(connectStr);
  send(sock, &length, sizeof(int), 0);
  send(sock, connectStr, strlen(connectStr), 0);

  char responseBuffer[1024] = {0};
  valread = read( sock , responseBuffer, 1024);
  printf(" %s sent, response = %x
", connectStr, responseBuffer[0]);

  char* gettcStr = "gettc";
  length = strlen(gettcStr);
  send(sock, &length, sizeof(int), 0);
  send(sock, gettcStr, strlen(connectStr), 0);

  valread = read( sock , responseBuffer, 1024);
  printf(" %s sent, response = %x timecode(%d:%d:%d:%d)
", gettcStr, responseBuffer[0], responseBuffer[1], responseBuffer[2], responseBuffer[3], responseBuffer[4]);

  return 0;
}

Chapter 192  TCP Protocol for DaVinci Resolve Transport Control
Project Databases, Collaborative, and Remote Workflows
Chapter 193

Managing Databases and Project Servers

This chapter describes how to set up and use databases in greater detail, giving you more control over how projects are saved and organized, including how to set up project servers you can use to administer DaVinci Resolve projects that are available to multiple DaVinci Resolve workstations on the same network.

Contents

Why Use a Project Server? 3576
Multiple Users Sharing Projects 3576
Using Collaborative Workflow 3576
Using the DaVinci Resolve Project Server Application 3576
The DaVinci Resolve Project Server Interface 3577
Using the Project Server Application to Manage Databases 3578
Creating New PostgreSQL Databases 3578
Backing Up and Restoring Databases 3578
Upgrading Databases 3579
Reconnecting Databases You Previously Disconnected 3579
Viewing Database Contents 3579
Optimizing Databases 3579
Sharing Databases to Create a Project Server 3580
Why Use a Project Server?

Multiple DaVinci Resolve workstations can access the same project when you set up a Project Server that shares one or more PostgreSQL databases over a local network. Once you’ve set this up, there are two ways of using a shared database.

Multiple Users Sharing Projects

The simplest case is for users to simply open up a project on the Project Server and work on it. Working this way, if you ever have to change rooms, or switch workstations, you can easily open that same project from any machine that’s connected to the server on the same network without needing to export and import it first. For example, an assistant could be working with a colorist to prepare files for the next reel by conforming shots, managing VFX replacements, doing dust busting repairs, and so on in an unsupervised editing suite anywhere in the building, before saving their work and closing the project so the colorist can immediately open that same project in the grading theater across the hall.

Another way of taking advantage of shared Project Servers is to split large projects into sections, so multiple artists can work in parallel on different pieces of the whole in different suites, handing them off when necessary. For example, a feature film may be split into reels, or a film can be separated from the trailer and electronic press kit projects that it shares media with. In this case, each project can be edited, mixed, and graded by different people accessing the Project Server.

When a shared project is opened by someone else after it’s already been opened, a dialog informs you that it’s being opened in Read-only mode to prevent multiple users from accessing the project at the same time. If you load a Read-only project and decide you want to make changes anyway, you’ll need to use the Save As command to create a duplicate project file using a new name in order to preserve your work.

Using Collaborative Workflow

Alternately, you can use the Collaborative Workflow features in DaVinci Resolve to enable multiple collaborators on multiple workstations in multiple rooms to open and work on the very same project at the same time. For example, an editor can be editing a project’s main timeline in one room, while an assistant organizes media and adds metadata within the same project in another room, and a colorist grades dailies in that same project in yet another room, all accessing the same Project Server which allows them to work together in parallel. For more information, see Chapter 194, “Collaborative Workflow.”

All participants in a Collaborative Workflow must have the Studio version of DaVinci Resolve, and they must be using a PostgreSQL database on a Project Server that’s properly set up.

Using the DaVinci Resolve Project Server Application

DaVinci Resolve Project Server is a stand-alone application that lets you create, manage, backup, restore, and most importantly share project databases on any workstation. Using this application, it’s not necessary to launch DaVinci Resolve just to manage your databases, and it’s no longer necessary to use Terminal to set up database sharing as before (although you still can if you want to).
The DaVinci Resolve Project Server Interface

The DaVinci Resolve Project Server interface greatly resembles the DaVinci Resolve Project Manager with the Databases sidebar open. However, a toolbar at the top exposes all of the database management tools that are available for creating and managing databases, including controls for sharing databases and creating access keys that are essential for quickly and easily creating and connecting to Project Servers.

This window has three main UI areas:

- **Databases list**: The Databases list in the Project Server application shows every single DaVinci Resolve PostgreSQL database on your machine; even ones that have been disconnected. This makes it easy to find databases that you want to reconnect. The icon of an arrow pointing up lets you know which databases need to be updated before they can be used with the current version of DaVinci Resolve. The icon of two arrows pointing away from one another indicates databases that are currently shared.

- **Projects browser**: Shows all projects and folders within the currently selected database as icons or as a hierarchical list.

- **Toolbar**: A toolbar at the top of the window shows you all of the functions that are available for managing DaVinci Resolve databases on your workstation.

  - **Enable Sharing**: Selecting a database and clicking this button lets you turn the workstation you're on into a Project Server. When you select a database that’s already shared, this button changes to Disconnect Database. This process is described in greater detail in the next section.

  - **New Database**: Lets you create new databases without needing to open DaVinci Resolve.

  - **Optimize**: Only available for PostgreSQL databases. Sometimes, databases in DaVinci Resolve can become so large that the size affects performance. In these cases you may need to optimize it to improve access speed by “vacuuming” the database of unnecessary spaces and reindexing it. You can now also access the Optimize Project command directly from the Project Manager window. Simply hover the mouse over your project in the Project Manager, hold down the Option key, and right-click. Then select Optimize Project in the menu.

  - **Backup**: You can back up databases just like any other file. This provides added protection should your system drive fail, but a database backup can also be used to move multiple projects
between systems (particularly if you’re using PostgreSQL). Clicking this button exports the currently selected database, with all enclosed projects, to a self-contained .resolve.backup file.

- **Restore**: Imports .resolve.backup files to restore a backed up database.
- **Add Folder**: Creates a project folder inside whatever database is currently selected.
- **Create Access Key**: Selecting a database and clicking this button exports an access key file that you can send to other users to quickly connect their workstation to a shared Project Server. This process is described in greater detail in the next section.

### Using the Project Server Application to Manage Databases

The DaVinci Resolve Project Server utility is useful for accomplishing all kinds of administrative tasks.

#### Creating New PostgreSQL Databases

If necessary, you can create new PostgreSQL databases right within this utility.

**To create a new PostgreSQL project database:**

1. Click the New Database button in the toolbar.
2. When the New Database window appears, type a name for the new database into the Name field. Because all projects in a PostgreSQL database are saved internally within the PostgreSQL database, no other changes are necessary.
3. Click Create, and the new disk database will appear in the Databases list.

#### Backing Up and Restoring Databases

You can also back up and restore databases without needing to open DaVinci Resolve. Furthermore, you can back up databases from older versions of DaVinci Resolve, making it easy to back up databases for safety before you upgrade them.

**To back up a database for safekeeping:**

1. Select the database you want to back up in the Databases list.
2. Click the Backup button in the toolbar.
3. Choose a location to which to save the backup in the Backup Database dialog, and click Save.

**To restore a database you’ve backed up previously:**

1. Click the Restore button in the toolbar.
2. Find the database you need to import using the file import dialog, and click Open. The database you’ve restored should now appear in the Databases list.
Upgrading Databases

From time to time, new versions of DaVinci Resolve require changes to the way projects are created, which requires databases created with older versions of DaVinci Resolve to be upgraded before you can access the projects within. Fortunately, this is a simple process.

To upgrade a database made or used with an older version of DaVinci Resolve:

- Right-click any database with an upgrade badge to the right of the database name, and choose Upgrade from the contextual menu.

Reconnecting Databases You Previously Disconnected

Unlike the Project Manager in DaVinci Resolve, the DaVinci Resolve Project Server application shows you every single DaVinci Resolve database on your computer, whether it’s connected to Resolve or not. For this reason, it’s a good way to find the names of databases that have been disconnected, either deliberately or accidentally, in order to reconnect them.

To reconnect any database on your workstation:

1. Open the DaVinci Resolve Project Server application.
2. Find the database you want to reconnect in the Databases list at the left.
3. Open DaVinci Resolve.
4. When the Project Manager window appears, open the Databases sidebar, and then drag the database you want to reconnect from the DaVinci Resolve Project Server window to the Database list of the Project Manager. That database is reconnected and appears in the Database list.

Viewing Database Contents

If you’re using multiple databases to organize your projects, you can browse the contents of each database to search for what you’re looking for. Simply click to select a database in the sidebar, and if necessary, use the drop-down menu at the right of the database listing to choose a specific user. An orange highlight will appear, and all projects corresponding to that database appear in the Project Manager window.

Optimizing Databases

Sometimes, databases in DaVinci Resolve can become so large that their size affects performance. In these cases you may need to optimize them to improve access speed by “vacuuming” the database of unnecessary spaces and reindexing it. Using the Optimize command can also be a valuable troubleshooting step in certain cases where you’re having problems opening, importing, or otherwise using projects saved within PostgreSQL databases.

To optimize a database:

- Right-click a database, and choose Optimize from the contextual menu. A dialog appears to confirm if you really want to optimize that database. Click Optimize to proceed.
Sharing Databases to Create a Project Server

You can also use the DaVinci Resolve Project Server to easily set up a shared Project Server on your local network. However, for this to work, you need to adhere to the following requirements:

- All workstations need to be connected to the Project Server on a local network.
- All network connections should be reasonably fast (preferably Gigabit Ethernet or faster).
- The computer functioning as the Project Server should be reasonably fast, but it doesn’t need fast GPU processing.
- The Project Server should have DaVinci Resolve installed, but it doesn’t need a dongle or serial number, nor need it be the Studio version.

The following procedures describe how to set up a shared Project Server, and how to export an access key with which to easily set up other workstations to connect to it.

To configure the DaVinci Resolve Project Server:

1. Open the DaVinci Resolve Project Server application.
2. In the File > Network Interface menu choose the IP address you wish to use to connect to the client workstations.

![Network Interface menu](image)

The Network Interface menu

**IMPORTANT**

You must select the appropriate Network Interface IP address that matches the network the client computers are on before you create and share a database or create an access key, otherwise a connection error will occur.

To share a database using the DaVinci Resolve Project Server:

1. Select or create a DaVinci Resolve project database you want to share, and click the Enable Sharing button. It’s the left-hand button on the top of the interface.
2. When a dialog appears asking if you want to authorize the configuration of your PostgreSQL server, click Authorize. That database can now be shared among other DaVinci Resolve workstations on the same network.

Once you’ve set up a Project Server, it’s easy to connect other machines to that server using access keys that you can create using the DaVinci Resolve Project Server application.
To create an access key to enable easy connection to a Project Server:

1. Select a database that you’ve set up to share, and click the Create Access Key button to the right in the toolbar.

2. Choose a location via the Create Access Key dialog, and click Save. An access key file is saved to the location you chose with the file extension .resolvedbkey.

3. Copy the .resolvedbkey file to the workstation you want to connect to the shared database.

4. Open DaVinci Resolve, and when the Project Manager appears, open the Databases sidebar, and then drag the .resolvedbkey file and drop it anywhere within the Project Manager. The shared database should now appear in the Databases sidebar, and if you select it, you’ll see all of the projects that are located in that database on the Project Server.

If necessary, you can also disable sharing for any database, preventing remote access to it from other workstations on the network.

To disable sharing:

1. With the DaVinci Resolve Project Server application open, select a database you enabled sharing for, and click the Disable Sharing button to the left in the toolbar.

2. When a dialog appears asking if you want to authorize the configuration of your PostgreSQL server. Click Authorize. That database will no longer be shared.

IMPORTANT

If you enable sharing on a computer that is later moved to another network (for example, if you set up Project Server sharing on a laptop), you’ll need to disable sharing and then re-enable it before you create access key files that will successfully connect to the new network location.
Multi-user collaborative workflow uses “bin locking” to manage who has access to what when multiple collaborators open the same project. However, collaborative workflow also allows multiple artists to do simultaneous editing, compositing, grading, and metadata entry to clips on the same timeline within a single project for which Collaboration has been enabled. Multiple users can simultaneously access the same timeline within the same project to edit, composite, and grade at the same time, while other editors and assistants can open different bins containing different timelines within the same project to do editorial and media management. This chapter describes how to set up multiple DaVinci Resolve workstations to collaborate, and how to use bin locking to work together.

Contents

Introduction to Collaborative Workflow 3583
Collaborative Render Cache Support 3583
Collaborative Support for Individual Monitoring 3584
Collaborative Marker, Flag, and Clip Color Support 3584
Read Only Mode 3584
Collaborative Support for HDR 3584
Requirements for Collaboration 3584
Enabling Project Collaboration 3584
Opening Projects to Collaborate 3585
Customizing Your Collaborator Identification 3586
Introduction to Collaborative Workflow

Multi-user collaborative workflow allows simultaneous editing, compositing, grading, and Media Pool clip management by multiple people within a single project that has been enabled for collaboration. Collaboration takes three different forms:

– Using bin locking, multiple editors can simultaneously edit different timelines in different bins of the same project, while assistant editors can reorganize clips and edit the metadata in other bins within the same project. Bins are automatically locked when selected by a particular user and unlocked when deselected by that same user, or they can be manually set to be either locked or unlocked as circumstances require.

– Using clip locking, multiple colorists and compositing artists can work together in the same timeline, in either the Color page or Fusion page, without fear of overwriting one another’s work. A clip is locked automatically when a user selects that clip to work on, and is unlocked (with the work checked in) when that same user selects a different clip. Clip locking in the Fusion page is maintained separately from clip locking on the Color page, so a compositing artist and colorist can work together on the same shot.

– One editor, one compositing artist, and one colorist can work together on the same clip in the same Timeline of the same project without conflict.

Overall, working in DaVinci Resolve in Collaborative Workflow mode is identical to working in non-collaborative mode. However, there are a few collaborative capabilities that are worth knowing about.

Collaborative Render Cache Support

Each collaborator on a project can have individualized render cache settings on their machine, enabling everyone to cache to a format that their workstation can best handle and that meets their needs.
Collaborative Support for Individual Monitoring

If necessary, each collaborator on a project can override the output and monitoring settings of a project on their particular workstation. When a project is set to use Collaborative Workflow, a “Use Local Overrides” checkbox appears in the Video Monitoring group of the Project Settings that lets you choose how to monitor on your particular workstation.

Collaborative Marker, Flag, and Clip Color Support

Collaborative workflow supports the modification of markers, flags, clip metadata, and clip color from the Color page. Additionally, FrameIO comment markers are supported by collaborative workflow.

Read Only Mode

Users can load collaborative projects in Read Only Mode.

Collaborative Support for HDR

Starting with DaVinci Resolve 16, there is support for Dolby Vision and HDR10+ in collaborative workflows.

Requirements for Collaboration

In order to use collaborative workflow:

– All users must be working on a project that’s been saved on a properly configured Remote Database Server. This Remote Database Server can be on one of the actively used DaVinci Resolve workstations, or it can be another computer on your network that simply hosts shared projects, but it should be on a computer that is never shut down or put to sleep, to prevent projects suddenly becoming unavailable.

– All machines participating in a collaborative workflow must be networked. They can be on the same local area network (LAN), but you can also connect computers on different subnets.

– Shared projects should ideally use media on some type of fast storage area network (SAN), with each collaborator connected to that SAN so that every workstation that’s connected to the project being collaborated on has direct access to the same media. In a pinch, shared volumes over a network will work, but properSANs will provide significant performance benefits. Facilities using multiple computer platforms (macOS, Windows, and Linux) together can use the Mapped Mount option of the Media Storage Locations list, found in the DaVinci Resolve System Preferences, to facilitate cross platform drive connection.

For more information on setting up a Database Server, see Chapter 193, “Managing Databases and Project Servers.”

Enabling Project Collaboration

Starting with DaVinci Resolve 14, the process of initiating a collaborative workflow has been vastly simplified over previous versions.

To open a project and initiate a collaborative workflow:

1. Open DaVinci Resolve on a computer that’s connected to a Remote Database Server.
2. Open any project on the remote database DaVinci Resolve is connected to using the Project Manager.
3. When the project is open, choose File > Enable Collaboration.
Once collaboration is enabled, two additional buttons appear at the lower right-hand corner of the DaVinci Resolve interface, next to the Project Manager and Project Setting buttons. These are the Collaboration Chat and Collaboration buttons.

The Collaboration Chat button (far left) and the Collaboration button (second from left)

**NOTE:** When you enable collaboration, the “Auto conform missing clips as media is added to Media Pool” option in the General Options panel of the Project Settings is automatically disabled, as it interferes with collaborative workflow. Also, Live Save is automatically turned on in the Auto Save panel of the User Preferences, to ensure that all collaborators’ work is saved regularly to avoid conflicts between collaborators.

**Opening Projects to Collaborate**

Projects that have Collaboration enabled appear with a badge below their thumbnail in the Project Manager to let you know that project is available for collaboration.

An icon indicates that a project in the Project Manager is available for collaboration

At this point, anyone else who has access to this Remote Database Server can simply open this project up and work collaboratively with you. Whenever a collaborator opens the same project you’re working in, the Collaboration Chat button at the bottom of the DaVinci Resolve UI highlights to let you know you have a message.

Opening the Collaboration Chat window shows who’s collaborating with you.

A new message in the Collaboration Chat window lets you know who else has opened the project you’re working on
Customizing Your Collaborator Identification

Once you've set up a project for collaboration, you want to make sure it's easy to tell all your collaborators apart. Clicking the Collaboration button opens a list of all collaborators, or project members, working in that project.

Opening the Collaboration list shows all the current project members.

The top member is you, and you can change the name you use by editing the text field. Additionally, you can click the icon to the left and choose a new color for yourself from the icons in the pop-up menu below. All the badges that indicate who has a lock on which folders, timelines, and shots are color-coded, so it's a good idea for everyone to choose their own custom color so you can tell who's doing what.

There are eight custom colors for collaborators to choose from.

How Collaboration Works

At its simplest, collaborative workflow uses a “first come, first served” model to manage who has can make changes to what. Essentially, the first collaborator to select a bin in the Media Pool, open a timeline, or select a clip in the Fusion page or Color page gets a “lock” on that item. Once an item is locked (indicated by a colored collaborator badge), other collaborators can look at it, but they cannot make changes. This prevents versioning conflicts from occurring.

Bin and clip locks are released when a collaborator selects a different bin or timeline in the Media or Edit pages, or a different clip in the Fusion page or Color page. At that point, the changes that have been made to the previously locked item are “checked in” and made available to all collaborators once they refresh their project (by clicking a circular refresh icon that appears to the right of bins in the Media Pool or in the corner of the Edit page Viewer).
All changes that collaborators make are automatically saved to the project as they’re made, via Live Save (which is always on in Collaborative mode), so no work will ever be lost as you collaborate with your team. However, each collaborator gets to decide when they want to update the bin, timeline, or clip they’re currently working on to see the changes made by everyone else, in order to prevent a kaleidoscope of constant alterations to compositions and grades from being a distraction while you’re working.

The following sections describe Bin and Timeline locking and Clip locking in more detail.

**Automatic Bin and Timeline Locking**

Whenever a collaborator opens a particular bin, that bin and its contents are locked, preventing any other collaborators who open that project from making alterations to anything inside that same bin. This prevents versioning conflicts while work is in progress. When a bin is locked, you can still view its contents, if for instance you just need to figure out where a particular clip has been put, but you can’t make changes.

Furthermore, when a collaborator opens a timeline in either the Edit or Fairlight pages, whatever bin that timeline is in is also locked as well, along with any other timelines or clips in that bin. Collaborators can open locked bins and see the contents for reference, but they cannot make any organizational or editorial changes. The only things that can be changed once a bin and its contents are locked are the creation or alterations of clip compositions in the Fusion page, and alterations to clip grades in the Color page.

You can always tell when a collaborator has a lock on a bin and its contents because a badge appears to the right of the bin in the Bin list, and in the corner of timeline thumbnails that are visible in the Media Pool browser area. Hovering the mouse over that badge in the Bin list reveals a tooltip with that collaborator’s name.

![An icon indicates that another collaborator has a lock on the Reel 2 bin, the Pool Shark (Trimming) timeline, and the Alternate bin](image)

Once a collaborator (someone other than you) makes changes to a bin’s contents or to a timeline, you’ll see a circular “refresh” badge appear by each affected bin in the Bin List of the Media Pool. Click these badges whenever you want to update your version of the shared project with all organizational and editorial changes made by others in that bin.

![An icon indicates that another collaborator has made changes, clicking it refreshes your project to show those changes](image)

To release a bin or timeline, simply select another bin or timeline. It’s that simple.
Managing Bin Locks Manually
You can also manually control the locked state of bins, during instances where you want to keep bins locked for future use or prevent them from becoming locked when you only want to browse the contents.

Keeping Bins Locked
If you want to lock one or more bins that you know you’re going to be switching among to either prevent other collaborators from making changes or so that nobody else inadvertently prevents you from having access, you can right-click one or more selected bins and choose Lock Bins to lock them. Bins locked in this way remain locked, even when you deselect them, until you right-click them again and choose Unlock Bins.

![Manually locked bins stay locked even when they're not selected](image)

Keeping Bins Unlocked
Additionally, you can choose to keep bins unlocked when selected. For example, you may just want to examine the contents of a bin without keeping someone else from editing its contents. In this case, simply Option-click any bin to open that bin in read-only mode, which is indicated by an eyeball badge to the left of that bin in the Bin list. In this mode, any other collaborator can still lock that bin while you’re examining its contents. Selecting any other bin will clear this read-only status.

![Selecting a bin in read only mode allows collaborators to lock that bin while you examine its contents](image)

**TIP:** While a bin is open but manually unlocked by you, you can still open clips into the Source Viewer and add markers to them, so long as another user doesn’t select that same bin and lock you out.

Manually Unlocking Timelines
You can also manually manage the locking of timelines. Ordinarily, opening a timeline automatically locks other collaborators out of making changes to that timeline, and also locks the bin that timeline appears within. However, if you’ve finished making changes to a timeline and you want to release it to other collaborators for immediate work, you can unlock the currently open timeline.

To unlock a timeline to let other collaborators work on it:

1. Right-click that timeline in the Media Pool and choose Timelines > Unlock Timeline from the contextual menu.
2. Your collaborator will then need to right-click the Media Pool bin the timeline is in to be able to edit it.
Automatic Clip Locking

Clip locking in the Fusion and Color pages works similarly. As multiple compositing artists work in the Fusion page, and multiple colorists work in the Color page, the first compositing artist or colorist to select any given clip has an automatic lock on that clip. Other compositing artists or colorists will see a badge on that clip in the Thumbnail timeline showing that it’s locked as well as letting them know who has the lock. In the following screenshot, a green badge at the corner of clip 12 in the Color page Thumbnail timeline indicates that clip is locked.

Automatically Checking In Work When You Change Clips

When you’re finished with the clip you’re working on, you need only select another clip for the changes you made to the previously selected clip to be automatically saved and pushed to all other colorists who are working on that timeline in the Color page. No refresh is needed. This is the main difference between clip locking in the Color page and bin locking.

Compositing Artists and Colorists Can Work Together

The Fusion page and Color page each maintain separate clip locks. This means that for any given pool of compositing artists, only one will be able to work on a given clip at a time, while in the Color page only a single colorist will be able to work on a clip at a time.

However, because Fusion and Color page clip locking is maintained separately, that means that one compositing artist and one colorist can work on a single clip in the timeline simultaneously, even while an editor is working on that timeline.

Receiving Changes Made by Collaborators

As you work collaboratively, it will be common for groups of compositing artists to be executing multiple compositions at a time, while colorist and their assistants will be working on the grade, and an editor and their assistants will be refining the edit, all working together within the same project.

Receiving Changes On the Edit Page

While compositors are compositing and colorists are grading clips within the same timeline of the same project, each clip that’s adjusted in the Fusion or Color page triggers a Refresh badge to appear in three areas of the Edit page, so the collaborating editor(s) can decide when to update their timeline to see the changes that have been made.

– At the upper right corner of the Timeline Viewer. Clicking this badge refreshes the composites and grades of all clips in the currently open Timeline.

A clickable “update” badge appears in the corner of the Timeline Viewer for timelines with edits, grades, and composites that have been updated.
At the right of the bin containing the modified timeline in the Media Pool’s bin list. Clicking this badge refreshes all clips in the Timeline within that bin.

A clickable “update” badge appears over bins containing timelines in the Media Pool with edits, grades, and composites that have been updated.

At the upper-right hand corner of each modified clip in the Timeline.

A clickable “update” badge appears over clips in the Timeline with edits, grades, and composites that have been updated.

Receiving Changes On the Fusion and Color Pages

For collaborators working on the Fusion or Color pages, other badges indicate when editors have made changes to the Timeline, or when other compositing artists or colorists have made changes to other clips in that timeline.

Timelines that you’re locked out of because another collaborator has a lock on them are indicated by a badge at the upper right corner of the Viewer, while changes made to the Timeline by editors on the Edit page are indicated by a refresh badge in the same location. Clicking this badge refreshes all clips in the Timeline.

A badge in the Viewer shows that a viewer has a lock on this timeline.

If you open up the Media Pool, then a badge appears at the right of any bin in the Bin List that’s been reorganized or that contains a modified timeline. Clicking this badge refreshes all clips in the Timeline within that bin.

A badge appears to the right of bins in the Media Pool containing timelines that have been updated.
A badge appears at the upper-right hand corner of each clip in the Thumbnail timeline that’s been modified by a fellow compositing artist or colorist. Clicking a single clip’s badge updates that clip alone.

Examples of Collaborators Working Together

The first collaborator that opens a timeline is the only person that can make editorial changes to that timeline in the Edit or Fairlight pages. Other collaborators who open that project are “locked out” of making changes to the Edit or Fairlight pages, but they can see the Timeline, and they can make grading changes in the Fusion or Color pages. This means in situations where you want multiple editors to be working on a project, it can be ideal to organize your program into separate “reels,” where each reel of a project is a separate timeline in a separate bin.

Multiple Editors Working Together

The first collaborator that opens a timeline is the only person that can make editorial changes to that timeline in the Edit or Fairlight pages. Other collaborators who open that project are “locked out” of making changes to the Edit or Fairlight pages, but they can see the Timeline, and they can make grading changes in the Fusion or Color pages. This means in situations where you want multiple editors to be working on a project, it can be ideal to organize your program into separate “reels,” where each reel of a project is a separate timeline in a separate bin.

On the other hand, if two or more editors must both work on the same timeline, this can be accomplished using duplicate timelines and then merging the changes back together later on. For example, collaborating editor Anne can do the following to make changes to a timeline that editor Erin is already working on:

- First, Anne can duplicate the locked timeline into a separate bin from the one Erin has a lock on. Alternately, Erin could be proactive and duplicate the timeline into a separate bin in advance.
- Second, Anne will re-edit the duplicate timeline to make whatever changes are necessary to a different scene than the one Erin is currently working on. Working on different scenes is the cleanest and easiest way of using this workflow.
- Third, Anne uses Collaborative Chat to notify Erin that the changes are finished.
- Fourth, Erin then refreshes the project to see Anne’s updated duplicate timeline in the Media Pool, right-clicks it, and chooses Compare With Current Timeline from the contextual menu to show the Timeline Comparison window that makes it possible to merge the changed section of the duplicate timeline with the original timeline that Erin already has open.

In the following screenshot, Erin’s highlighted changes (made while Anne was working) can be seen at the left, and Anne’s highlighted changes can be seen at the right. Right-clicking within the right highlighted area reveals an Accept Change command that lets that scene’s changes be merged from the duplicate timeline back to Erin’s original timeline.
Using the Compare With Current Timeline command lets you see the differences between two differently edited versions of the same timeline, and merge a scene’s worth of changes that a collaborator has made (at right) back to the original timeline.

For more information on comparing timelines, see Chapter 35, “Creating and Working with Timelines.”

Editors and Assistant Editors Working Together

Collaborators can edit metadata, create new bins, and reorganize clips within unlocked bins only. This means that your project should be organized so that an editor can lock the contents of the bins they need to work with at a given point in time, while the assistants can work on additional timelines and media within other bins in that project.

However, in addition to being able to copy timelines from a locked bin to a bin that you control, you can also copy clips from one timeline to another. In this way, if you absolutely need to make changes to source clips while the original source clips are locked, you can make your changes to copies of these clips.

Editors and Compositing Artists Working Together

Editors and compositing artists can work together closely, since compositing artists can create compositions for one or more clips in a timeline while it’s being edited, even though that timeline and the bin it’s in are locked to other editors.

Here’s an example of an editor working on a commercial spot with a lot of greenscreen material working together with one or more compositing artists.

First, the editor cuts together each foreground clip with actors performing as a rough cut, and once that rough cut is assembled, they edit in the background clips that accompany each greenscreen clips to create a series of stack of clips.

Second, the editor selects each stack of clips, one by one, and uses the New Fusion Clip command to create Fusion clips that the compositing artists can work on. By making each of these clips into Fusion clips, the editor is making it easy for the compositing artists to have access to all the clips necessary for each composition from within the Fusion page, collaboratively.

At this point, the editor uses collaborative chat to notify the compositing artists that there are composites ready for them to work on, and the editor can then turn their attention back to refining the edit.

Upon being notified that they can begin work, one or more compositing artists start working through the Fusion clip compositions while the editor is working, to create each multi-layered composite that’s necessary. As each compositing artist finishes a clip and moves to a new clip to begin work, the editor sees a notification badge at the upper right corner of each clip in the Timeline that’s been composited, as well as notification badges in the Bin List of the Media Pool, and at the upper right corner of the Timeline viewer. Clicking any of these badges will refresh one or more of these clips, so the editor can see the changes.
Multiple Compositing Artists Working Together

To prevent versioning issues, only one compositing artist can work on a particular clip at a particular time in the Fusion page, and the first compositing artist to select a clip puts a lock on that clip. Other collaborators looking at the Thumbnail timeline in the Fusion page will see a small icon that shows it’s locked, letting them know they can’t make any changes to it until whoever is working on that composition moves to another clip.

![A small icon indicates that you're locked out because another compositing artist is working on that clip](image)

This means that multiple compositing artists can’t work on the same composition at the same time. However, an assisting compositing artist can do preparatory work on one composition, such as doing rotoscoping, paint, particle system design, or any other time-consuming task, while a lead compositing artist works on another shot in the meantime. Once the assisting compositor is done, they can select another clip to work on and use collaborative chat to let the other compositor know they’re done and that clip is ready for more work.

In order to prevent half-finished work from being disseminated to other collaborators, a clip that’s in the process of being worked on in the Fusion page isn’t updated for anyone else who’s working on that same timeline until the compositing artist who’s working on it selects another clip. Immediately upon being deselected, all changes are automatically checked in and made available to all other collaborators, who see notification badges in the Fusion page and the Edit page to alert them that changes are available and that they can refresh their timeline to see the updates.

Editors and Colorists Working Together

Colorists and editors can work together very closely in DaVinci Resolve, as colorists can grade the shots of a timeline that an editor is currently working on, even though that timeline and the bin it’s in are locked to other editors.

From the colorist’s point of view, whenever the editor makes an alteration to the Timeline, a badge appears at the upper right hand corner of the Color page Viewer to indicate that a change has been made to the timeline being graded. Clicking this badge updates the timeline the Colorist is working on.

In order to prevent half-finished work from being disseminated to the editor (or worse, being seen by the client), clips that are in the process of being graded aren’t updated for other collaborators that are looking at that timeline until the colorist who’s working on it “checks in” their work by selecting another clip. So, from the editor’s point of view, whenever a colorist has finished grading a clip and has selected another clip to grade, a series of badges appear in the Edit page, one on the clip that’s been graded, one on the Timeline Viewer and one on the bin in the Bin List that contains the Timeline. Clicking any of these badges updates the Timeline with the latest grades.
Multiple Colorists Working Together

Only one colorist can work on a particular clip at a particular time, and the first colorist to select a clip puts a lock on that clip. Other collaborators looking at the Thumbnail timeline in the Color page will see a small icon that shows it’s locked, letting them know they can’t make any changes to it until whoever is grading that clip moves to another clip.

In order to prevent half-finished work from being disseminated to other colorists or editors, a clip that’s in the process of being graded isn’t updated for other collaborators that are looking at that timeline until the colorist who’s working on it selects another clip. These changes are then automatically made available to all other collaborators working in the Color page, who see badges appear in the Edit and Color pages to indicate which clips have updates available.

This makes it easy for multiple colorists to work together. For example, an assistant colorist can be notified via Collaborative Chat to draw a custom window that a senior colorist needs for a grade. The assistant opens that timeline in another suite, selects the appropriate clip, and draws the window. Once finished, the assistant simply selects a different clip, and the changes they’ve made are immediately available to the senior colorist, who sees a badge on that clip in the Thumbnail timeline and can click to update it.

Managing Notes Among Collaborators

If an editor wants to send a note to colorists or compositing artists, they can do one of the following:

- They can add a marker with note text to the Timeline ruler (the marker appears in the marker submenu in the Color page Viewer option menu)
- They can add a marker with note text to a clip (that marker appears in the mini-timeline of the Color page)
- They can color code clips in different ways to get the colorist’s attention (clip color coding appears as a dot in the Thumbnail timeline).
- Of course, the editor and colorist can always interact via the collaborative chat window, as well.
Collaboration Chat

To facilitate communication among collaborators, DaVinci Resolve has built-in text chat, called Collaboration Chat. Simply click the Collaboration Chat button to open the chat window, and chat away.

The Collaboration Chat window for communication among collaborators.

The Collaboration Chat button at the bottom of the DaVinci Resolve interface highlights orange whenever someone texts while this window is closed, letting you know you have messages that are waiting.

The Collaboration Chat button highlights to let you know you have a message.
Chapter 195

Remote Grading

This chapter describes how to set up and use two separate DaVinci Resolve systems in different locations via the internet, to have one system remotely control the other for color grading.

Contents

- Introduction to Remote Grading 3597
- Requirements for Remote Grading 3597
- Setting Up for Remote Grading 3598
- Remote Grading Restrictions 3598
Introduction to Remote Grading

To enable colorists to work interactively with clients across the globe, DaVinci Resolve offers a remote grading option. It allows two matching DaVinci Resolve systems to be synchronized via an Internet connection such that changes made on the colorist’s workstation are immediately applied on the remote client’s workstation.

Cue commands are also synchronized to ensure that both systems are always on the same frame in the Timeline. Starting or stopping playback on the colorist’s DaVinci Resolve also starts and stops the remote client system. While a remote grading session is in progress, input from the user at the remote client’s DaVinci Resolve workstation is ignored.

Currently, the remote grading feature supports only color correction and does not allow editing or conforming during a session. The two colorist and remote DaVinci Resolve systems must have matching timelines and the number of clips, clip durations, and system resolutions must match. The requirements and limitations of a remote grading session are summarized below.

Requirements for Remote Grading

– The same version of DaVinci Resolve must be installed on both systems.
– The Timeline to be graded must be conformed on both machines prior to the start of the remote grading session.
– The number of clips on the Timeline and the duration of each clip must be identical.
– While grading, the active Timeline and versions on the remote client system are constantly updated. Creating, deleting, or switching the Timeline on the client’s DaVinci Resolve is not allowed. Doing so will terminate the remote grading session immediately.
– You cannot make any grading adjustments on the remote client’s DaVinci Resolve workstation until the remote grading session has ended.

**NOTE:** Remote grading does not require a shared database.
Setting Up for Remote Grading

To start a remote grading session, the client’s DaVinci Resolve must be able to connect to the colorist’s system using TCP/IP.

1. Open DaVinci Resolve on the remote client’s workstation (the one that’s being remotely controlled), log in, and open the project that will be remotely graded.

2. Choose Workspace > Remote Grading (Ctrl-G) on the remote client’s workstation. A window is displayed with text fields to enter the IP address and port number of the colorist’s system.

3. Set the IP address field to the IP of the colorist’s DaVinci Resolve workstation. If the colorist’s system already has a public IP address, the port number can be left at its default value (15000). If the colorist’s system is on a private network, the colorist or their network administrator should set the port number to one on the public IP router that is internally routed to port 15000 of the colorist’s DaVinci Resolve.

4. Once the remote client clicks Connect, the client’s DaVinci Resolve system will attempt to establish a connection with the remote colorist’s workstation.

5. Once the connection is established, a pop-up appears on the colorist’s screen asking for permission to accept a Remote Grading connection.

6. Click OK to accept, minimize the size of this dialog window, and continue grading normally.

The Remote Grading session will remain active until one of the users chooses to disconnect or an error occurs causing DaVinci Resolve to automatically terminate the session.

Remote Grading Restrictions

To allow operation over low bandwidth and a potentially long latency Internet connection there are some restrictions to remote operation.

– When playback is started, the playback speeds on the two DaVinci Resolve systems may differ. The frame positions are only guaranteed to be synchronized when playback is stopped.

– Input/output/display LUTs applied from the Config page on the colorist’s DaVinci Resolve will not have any effect on the client system. LUTs selected on the client’s DaVinci Resolve will be applied instead.

– Presets applied from the Config/Color pages on the colorist’s system will not have any effect on the client’s system. Presets selected on the client’s DaVinci Resolve will be applied instead.
Other Information
Other Information

Regulatory Notices, Safety Information and Warranty

Contents

Regulatory Notices  3601
Safety Information  3603
Warranty  3604
Disposal of Waste of Electrical and Electronic Equipment Within the European Union.

The symbol on the product indicates that this equipment must not be disposed of with other waste materials. In order to dispose of your waste equipment, it must be handed over to a designated collection point for recycling. The separate collection and recycling of your waste equipment at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you purchased the product.

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. Operation of this product in a residential area is likely to cause harmful interference, in which case the user will be required to correct the interference at personal expense.

Operation is subject to the following two conditions:

1. This device may not cause harmful interference.
2. This device must accept any interference received, including interference that may cause undesired operation.

Davinci Resolve Advanced Panel  KCC-REM-BMD-DaVinciResolve
Davinci Resolve Mini Panel     MSIP-REM-BMD-201708001
Davinci Resolve Micro Panel   MSIP-REM-BMD-201703002
Davinci Resolve Studio USB Keylock MSIP-REM-BMD-201705001
DaVinci Resolve Editor Keyboard R-R-BMD-201907001
DaVinci Resolve Speed Editor   R-R-BMD-2020021001

Fairlight Desktop Audio Editor R-R-BMD-2020103002
Fairlight Console Audio Editor R-R-BMD-2020103002
Fairlight Console LCD Monitor R-R-BMD-2020103003
Fairlight Console Channel Fader R-R-BMD-2020103004
Fairlight Console Channel Control R-R-BMD-2020103005
Fairlight PCIe Audio Accelerator R-R-BMD-2020103006
Fairlight Audio Interface     R-R-BMD-2020103007
Fairlight PCIe Audio MADI Upgrade R-R-BMD-2020103008
Fairlight Desktop Console    R-R-BMD-20200728001
Fairlight HDMI Monitor Interface R-R-BMD-20200729001
ISED Canada Statement

This device complies with Canadian standards for Class A digital apparatus.

Any modifications or use of this product outside its intended use could void compliance to these standards.

Connection to HDMI interfaces must be made with high quality shielded HDMI cables.

This equipment has been tested for compliance with the intended use in a commercial environment. If the equipment is used in a domestic environment, it may cause radio interference.

Bluetooth®

The DaVinci Resolve Speed Editor is a Bluetooth wireless technology enabled product.

Contains transmitter module FCC ID: QOQBGM113

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment.

Contains transmitter module IC: 5123A-BGM113

This device complies with Industry Canada's license-exempt RSS standards and exception from routine SAR evaluation limits given in RSS-102 Issue 5.

Certified for Japan, certificate number: 209-J00204. This equipment contains specified radio equipment that has been certified to the technical regulation conformity certification under the radio law.

This module has certification in South Korea, KC certification number: MSIP-CRM-BGT-BGM113

Pending Certification for South Africa by ICASA, approval number TA-2021/XXXX

Certified for Mexico (NOM), for Bluetooth module manufactured by Silicon Labs, model number BGM113A

Includes transmitter module certified in Mexico IFT: RCBSIBG20-2560

Hereby, Blackmagic Design declares that the product (DaVinci Resolve Speed Editor) is using wideband transmission systems in 2.4 GHz ISM band is in compliance with directive 2014/53/EU.

The full text of the EU declaration of conformity is available from compliance@blackmagicdesign.com
Safety Information

Weight Warning
The Fairlight Console has considerable weight even when empty. For example, a 3 Bay console weighs up to 110 kg empty, and 157 kg fully assembled. You should always move a Fairlight console with at least 4 people using safe lifting procedures, such as keeping the back straight, bending the knees and lifting with careful, controlled movements.

Electrical Warning Notice and Disclaimer
For installations involving the fitting of more than five Fairlight modules, additional earthing requirements must be fitted before connecting the supply. This requirement does not apply if each group of five Fairlight modules can be connected to separate wall or floor socket outlets. Earth posts are welded internally at both ends of the console frame for connecting earth wires from the console frame to the building earth point. Either of these posts can be used and they are marked with the following label.

Blackmagic Design recommends appointing a qualified and licenced electrician to install, test and commission this wiring system.

Blackmagic Design does not accept responsibility for the safety, reliability, damage or personal injury caused to, or by, any third-party equipment fitted into the console.

For protection against electric shock, the equipment must be connected to a mains socket outlet with a protective earth connection. In case of doubt contact a qualified electrician.

To reduce the risk of electric shock, do not expose this equipment to dripping or splashing.

Product is suitable for use in tropical locations with an ambient temperature of up to 40°C.

Ensure that adequate ventilation is provided around the product and that it is not restricted.

When rack mounting, ensure that the ventilation is not restricted by adjacent equipment.

No operator serviceable parts inside product. Refer servicing to your local Blackmagic Design service center.

The DaVinci Resolve Speed Editor contains a single cell Lithium battery. Keep lithium batteries away from all sources of heat, do not use the product in temperatures greater than 40°C.

Use only at altitudes not more than 2000m above sea level.

State of California statement
This product can expose you to chemicals such as trace amounts of polybrominated biphenyls within plastic parts, which is known to the state of California to cause cancer and birth defects or other reproductive harm.

For more information go to www.P65Warnings.ca.gov.
Warranty

12 Months Limited Warranty

Blackmagic Design warrants that DaVinci Resolve color grading control panels, editing keyboards and audio consoles will be free from defects in materials and workmanship for a period of 12 months from the date of purchase. If a product proves to be defective during this warranty period, Blackmagic Design, at its option, either will repair the defective product without charge for parts and labor, or will provide a replacement in exchange for the defective product. Periodical updates to the operational software are not included under this warranty.

In order to obtain service under this warranty, you the Customer, must notify Blackmagic Design of the defect before the expiration of the warranty period and make suitable arrangements for the performance of service. The Customer shall be responsible for packaging and shipping the defective product to a designated service center nominated by Blackmagic Design, with shipping charges pre paid. Customer shall be responsible for paying all shipping changes, insurance, duties, taxes, and any other charges for products returned to us for any reason.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate maintenance and care. Blackmagic Design shall not be obligated to furnish service under this warranty: a) to repair damage resulting from attempts by personnel other than Blackmagic Design representatives to install, repair or service the product, b) to repair damage resulting from improper use or connection to incompatible equipment, c) to repair any damage or malfunction caused by the use of non Blackmagic Design parts or supplies, or d) to service a product that has been modified or integrated with other products when the effect of such a modification or integration increases the time or difficulty of servicing the product.

This warranty is given by Blackmagic Design in lieu of any other warranties, express or implied. Blackmagic Design and its vendors disclaim any implied warranties of merchantability or fitness for a particular purpose. Blackmagic Design’s responsibility to repair or replace defective products is the whole and exclusive remedy provided to the customer for any indirect, special, incidental or consequential damages irrespective of whether Blackmagic Design or the vendor has advance notice of the possibility of such damages. Blackmagic Design is not liable for any illegal use of equipment by customer. Blackmagic is not liable for any damages resulting from use of this product. User operates this product at own risk.

© Copyright 2021 Blackmagic Design. All rights reserved. ‘Blackmagic Design’, ‘DaVinci’, ‘Resolve’, ‘DeckLink’, ‘HDLink’, ‘Videohub’, ‘DeckLink’, and ‘Leading the creative video revolution’ are registered trademarks in the US and other countries. All other company and product names may be trademarks of their respective companies with which they are associated. Thunderbolt and the Thunderbolt logo are trademarks of Intel Corporation in the U.S. and/or other countries. Dolby, Dolby Vision, and the double-D symbol are registered trademarks of Dolby Laboratories Licensing Corporation.